New York Now Platform Capabilities

Last updated: February 19, 2021
Some examples and graphics depicted herein are provided for illustration only. No real association or connection to ServiceNow products or services is intended or should be inferred.

If you have comments about this documentation, submit your feedback to:

docfeedback@servicenow.com
# Table of Contents

**Now Platform capabilities** ........................................................................................................................... 9

- Advanced Work Assignment......................................................................................................................... 16
- Get started with Advanced Work Assignment............................................................................................ 19
- Service channels .......................................................................................................................................... 24
- Work item queues ......................................................................................................................................... 33
- Work assignments .......................................................................................................................................... 39
- Agent Inbox controls ................................................................................................................................... 43
- Enable logging for Advanced Work Assignment........................................................................................ 45
- Out-of-the-box Performance Analytics Solutions for Advanced Work Assignment.................................. 46

**Agent Workspace** ........................................................................................................................................ 53

- Navigating Agent Workspace........................................................................................................................ 53
- Agent Workspace administrator configuration .............................................................................................. 55
- Completing your tasks with Agent Workspace............................................................................................ 128
- Domain separation and Agent Workspace................................................................................................... 153

**Configuration Management Database** ....................................................................................................... 153

- Configuration Management and the CMDB ............................................................................................... 154
- Domain separation in Configuration Management Database (CMDB)....................................................... 156
- ITIL Configuration Management integration ............................................................................................... 156
- ITIL ............................................................................................................................................................... 157
- Populate the CMDB .................................................................................................................................... 159
- CMDB schema model ................................................................................................................................. 163
- CMDB CI Class Models store app ................................................................................................................ 207
- Application services ..................................................................................................................................... 247
- Baseline CMDB ........................................................................................................................................... 282
- Managing proposed changes ....................................................................................................................... 285
- CI relationships in the CMDB ...................................................................................................................... 289
- CMDB classifications .................................................................................................................................. 306
- Querying the CMDB ..................................................................................................................................... 312
- CMDB Search .............................................................................................................................................. 329
- CMDB CI Lifecycle Management ................................................................................................................ 333
- CMDB groups .............................................................................................................................................. 341
- CMDB Identification and Reconciliation ..................................................................................................... 343
- CMDB Health ............................................................................................................................................. 389
- Duplicate CIs .............................................................................................................................................. 418
- CI Class Manager ......................................................................................................................................... 428
- Agent Workspace for Configuration Management Database (CMDB)..................................................... 429
- View CMDB benchmarks ............................................................................................................................. 433
- CMDB APIs (CMDB SDK) .......................................................................................................................... 434
- Quick start tests for Configuration Management Database (CMDB)....................................................... 435
- Useful related lists in CI forms ...................................................................................................................... 437
- Activate the Extended CMDB plugins......................................................................................................... 438
- Help the Help Desk ...................................................................................................................................... 438
- Enterprise CMDB ....................................................................................................................................... 451
- Table form views .......................................................................................................................................... 454
- Out-of-the-box Configuration Management (CMDB) Performance Analytics Solutions.......................... 455

**Dependency Views** ..................................................................................................................................... 455

- Supported browsers for Dependency Views ............................................................................................... 456
- Domain separation and Dependency Views ................................................................................................. 456
- Dependency Views map .................................................................................................................................. 457
- Dependency Views map menus and controls ............................................................................................... 458
| Cluster nodes in a Dependency Views map                          | 462 |
| Virtual grouping of nodes in a Dependency Views map             | 465 |
| Use Dependency Views                                           | 467 |
| Administer Dependency Views                                    | 472 |
| Properties for Dependency Views                                | 481 |
| Components installed with Dependency Views                     | 484 |

**Connect**

| Supported browsers for Connect                                   | 485 |
| Activate Connect                                                 | 486 |
| Activate Connect Support                                         | 486 |
| Connect interface                                                | 489 |
| Enable or disable Connect notifications globally                  | 501 |
| Edit which notifications you receive for a conversation          | 502 |
| Upload a profile picture                                         | 504 |
| Drag a file into a Connect conversation                          | 505 |
| Share a Visual Task Board in a Connect conversation              | 505 |
| Mention a user in a Connect conversation                         | 505 |
| Connect administration                                           | 506 |
| Connect Chat                                                     | 516 |
| Connect Support                                                  | 522 |

**Content Management System**

| Content Management design                                       | 539 |
| Domain separation in the Content Management System              | 547 |
| Configure Content Management sites                              | 547 |
| Content Management integration points                           | 598 |
| Content Management testing                                      | 605 |
| Global search in Content Management                             | 606 |
| CMS translation                                                 | 606 |

**Credentials and connection information**

| Introduction to credentials, connections, and aliases           | 607 |
| Domain separation for Credentials and Connections              | 608 |
| Create connection attributes for IntegrationHub                 | 609 |
| Setting up connections to target hosts                         | 610 |
| Getting started with credentials                                | 611 |
| Credential alias for Orchestration activities                   | 617 |
| Check IP service affinity for Discovery and Orchestration       | 678 |

**Data Certification**

| Activate Data Certification                                     | 681 |
| Certification schedules                                         | 681 |
| Certification tasks                                             | 687 |
| Certification elements                                           | 689 |
| Certification instances                                         | 691 |
| Certification audit instances                                   | 692 |
| Certification audit definition                                  | 693 |
| Data Certification Overview module                              | 694 |
| Data Certification planning                                     | 696 |
| Data certification performance                                  | 699 |
| Reassign a certification task                                   | 710 |
| Send certification task reminders                               | 717 |
| Mark a certification task as closed incomplete                  | 717 |
| Certification tasks cancellation                                 | 718 |
| Domain separation and Data Certification                        | 719 |

**Decision Tables**

| Create a decision table to resolve complex decisions             | 720 |
| Decision table properties                                       | 721 |

**E-signature**

<p>|...........................................................................................................................................| 724 |</p>
<table>
<thead>
<tr>
<th>Knowledge Management</th>
<th>1433</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interaction Management</td>
<td>1430</td>
</tr>
<tr>
<td>Instance Data Replication (IDR)</td>
<td>1025</td>
</tr>
<tr>
<td>Flow Designer</td>
<td>861</td>
</tr>
<tr>
<td>- Getting started with flows</td>
<td>863</td>
</tr>
<tr>
<td>- Getting started with actions</td>
<td>872</td>
</tr>
<tr>
<td>- Architecture Overview</td>
<td>882</td>
</tr>
<tr>
<td>- Flows</td>
<td>895</td>
</tr>
<tr>
<td>- Action Designer</td>
<td>1025</td>
</tr>
<tr>
<td>- Domain separation and Flow Designer</td>
<td>1089</td>
</tr>
<tr>
<td>- User access to Flow Designer</td>
<td>1091</td>
</tr>
<tr>
<td>- API access to Flow Designer</td>
<td>1092</td>
</tr>
<tr>
<td>- Spokes</td>
<td>1094</td>
</tr>
<tr>
<td>- Set up Instance Data Replication (IDR)</td>
<td>1102</td>
</tr>
<tr>
<td>- Request an Instance Data Replication (IDR) subscription</td>
<td>1104</td>
</tr>
<tr>
<td>- Create a producer replication set in Instance Data Replication (IDR)</td>
<td>1106</td>
</tr>
<tr>
<td>- Create a consumer replication set for Instance Data Replication (IDR)</td>
<td>1116</td>
</tr>
<tr>
<td>- Grant access to the replicated data for Instance Data Replication (IDR)</td>
<td>1122</td>
</tr>
<tr>
<td>- Transform replication data for Instance Data Replication (IDR)</td>
<td>1124</td>
</tr>
<tr>
<td>- Bidirectional replication for Instance Data Replication (IDR)</td>
<td>1127</td>
</tr>
<tr>
<td>- Seed a consumer instance for Instance Data Replication (IDR)</td>
<td>1129</td>
</tr>
<tr>
<td>- Trigger workflows after replications for Instance Data Replication (IDR)</td>
<td>1130</td>
</tr>
<tr>
<td>- Resolve errors for Instance Data Replication (IDR)</td>
<td>1131</td>
</tr>
<tr>
<td>- Adapter descriptions for Instance Data Replication (IDR)</td>
<td>1140</td>
</tr>
<tr>
<td>- Instance Data Replication (IDR) and blacklisted tables blacklisted tables</td>
<td>1143</td>
</tr>
<tr>
<td>IntegrationHub</td>
<td>1144</td>
</tr>
<tr>
<td>- Request IntegrationHub</td>
<td>1145</td>
</tr>
<tr>
<td>- IntegrationHub available spokes</td>
<td>1151</td>
</tr>
<tr>
<td>- Data Stream actions and pagination</td>
<td>1386</td>
</tr>
<tr>
<td>- Integration steps</td>
<td>1402</td>
</tr>
<tr>
<td>- Password reset using IntegrationHub</td>
<td>1430</td>
</tr>
<tr>
<td>Interaction Management</td>
<td>1430</td>
</tr>
<tr>
<td>- Activate the interaction management system</td>
<td>1430</td>
</tr>
<tr>
<td>- Interaction configuration overview</td>
<td>1431</td>
</tr>
<tr>
<td>- Create an interaction</td>
<td>1432</td>
</tr>
<tr>
<td>Knowledge Management</td>
<td>1433</td>
</tr>
<tr>
<td>- Additional plugins for Knowledge Management</td>
<td>1434</td>
</tr>
<tr>
<td>- Knowledge Management roles</td>
<td>1435</td>
</tr>
<tr>
<td>- Knowledge properties</td>
<td>1436</td>
</tr>
<tr>
<td>- Knowledge Management setup guide for admins</td>
<td>1454</td>
</tr>
<tr>
<td>- Domain separation and Knowledge Management</td>
<td>1455</td>
</tr>
<tr>
<td>- Knowledge base setup guide for knowledge admins and managers</td>
<td>1459</td>
</tr>
<tr>
<td>- Quick start tests for Knowledge Management</td>
<td>1460</td>
</tr>
<tr>
<td>- Configure Knowledge Management</td>
<td>1461</td>
</tr>
<tr>
<td>- Knowledge-Centered Service configuration</td>
<td>1549</td>
</tr>
<tr>
<td>- Use Knowledge Management</td>
<td>1566</td>
</tr>
<tr>
<td>- Translation management</td>
<td>1619</td>
</tr>
</tbody>
</table>
Managed Documents.................................................................................................................... 1791
Managed Document features........................................................................................................... 1791
Create a new managed document record...................................................................................... 1795
Check in a document after making changes.................................................................................. 1796
Check out a document to make changes....................................................................................... 1796
Publish a document in Managed Documents................................................................................ 1797
Send a document out for review and approval............................................................................... 1797
Upload a document as an attachment............................................................................................ 1798
Defining Document Parameters..................................................................................................... 1798
Defining Document Workflow.......................................................................................................... 1802
Knowledge document.................................................................................................................... 1804
Create a document........................................................................................................................ 1806
Domain separation and Managed Documents................................................................................ 1819

MetricBase................................................................................................................................ 1819
Purchase the MetricBase product.................................................................................................... 1821
Getting familiar with MetricBase.................................................................................................... 1821
Define and collect MetricBase data................................................................................................ 1833
Detect anomalies using predictive models..................................................................................... 1836
Access MetricBase data.................................................................................................................. 1840
MetricBase triggers........................................................................................................................ 1842
Maintain MetricBase...................................................................................................................... 1858
Get familiar with MetricBase APIs................................................................................................ 1862
Domain separation and MetricBase................................................................................................ 1869

MID Server.................................................................................................................................. 1869
Configure MID Server network connectivity................................................................................... 1871
Installing the MID Server................................................................................................................ 1875
Configuring MID Servers................................................................................................................ 1916
Securing and encrypting MID Server data....................................................................................... 1968
MID Server upgrades....................................................................................................................... 1984
Resolving MID Server issues........................................................................................................... 1991
MID Server reference information.................................................................................................... 2017

Notifications.................................................................................................................................. 2075
Email and SMS notifications............................................................................................................ 2076
Push notifications............................................................................................................................ 2248
Subscription-based notifications..................................................................................................... 2275
Notifications in messaging applications.......................................................................................... 2311
Email digests................................................................................................................................... 2331
Automating system responses to inbound email................................................................. 2342
Inbound email actions.......................................................................................................... 2344

Notify.................................................................................................................................. 2375
Activate Notify..................................................................................................................... 2376
Notify-Twilio Direct driver.................................................................................................. 2377
Notify Zoom connector...................................................................................................... 2382
Notify voice and SMS capabilities...................................................................................... 2384
Using Notify with tasks...................................................................................................... 2401
Using Notify with Incident Communications Management.............................................. 2403
Using Notify with On-Call Scheduling................................................................................ 2404
Notify administration........................................................................................................... 2407

Orchestration.......................................................................................................................... 2431
Introduction to Orchestration............................................................................................... 2431
Domain separation in Orchestration.................................................................................... 2434
Activate Orchestration.......................................................................................................... 2434
Orchestration applications................................................................................................. 2458
Orchestration examples....................................................................................................... 2513
Orchestration activity packs............................................................................................... 2521
Orchestration activity designer........................................................................................... 2661
Orchestration databus.......................................................................................................... 2772
MID Servers for Orchestration............................................................................................ 2775
Use the Orchestration Usage dashboard.............................................................................. 2781

Password Reset application.................................................................................................. 2783
Password Reset setup guide................................................................................................. 2783
Password Reset admin guide.............................................................................................. 2803
User guide: Resetting your password.................................................................................. 2887

Remote tables......................................................................................................................... 2895
Activate the remote tables plugin....................................................................................... 2897
Create a remote table........................................................................................................... 2898
Create a script definition for a remote table....................................................................... 2899
Debugging remote table script definitions.......................................................................... 2907
Domain separation and remote tables.................................................................................. 2908

Response templates.............................................................................................................. 2908
Activate response templates............................................................................................... 2910
Create or modify a response template.................................................................................. 2912

Self-service............................................................................................................................ 2917
Service catalog requests...................................................................................................... 2917
Service Delegation................................................................................................................. 2927

Service administration........................................................................................................ 2930
Assessments........................................................................................................................ 2930
Approvals............................................................................................................................ 3084
State flows............................................................................................................................. 3106
Geolocation.......................................................................................................................... 3114
Survey Management........................................................................................................... 3120
Quizzes................................................................................................................................. 3224
Wizards................................................................................................................................. 3256

Service Portal......................................................................................................................... 3256
Understanding Service Portal.............................................................................................. 3257
Content Management and Service Portal........................................................................... 3260
Supported features in Service Portal.................................................................................. 3278
Domain separation in Service Portal................................................................................... 3285
Antivirus Scanning in Service Portal.................................................................................... 3285
Set up Service Portal............................................................................................................ 3289
Create a portal...................................................................................................................... 3294
Service Portal pages............................................................................................................. 3319
Service Portal widgets......................................................................................................... 3351
Now Platform capabilities

Digitize your workflows and run them at scale by using the core capabilities of the Now Platform®. When you activate and configure these features, you can create custom business logic, manage and secure data, and build alternate user interfaces.
Digitize your workflows with the Now Platform

Use native platform intelligence to predict, prioritize, and proactively manage the work that matters most for your own organization.

View and download the full infocard for a highlight of Now Platform capabilities features.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automate work with Flow Designer</strong></td>
<td>Use Flow Designer to quickly build and extend modern workflow apps on a single, unified platform that works across the enterprise.</td>
</tr>
<tr>
<td><strong>Connect your enterprise with IntegrationHub</strong></td>
<td>Build your own reusable workflow apps that are powered by your business data on a single platform, or extend your own apps by using available integrations.</td>
</tr>
<tr>
<td><strong>Create engaging app experiences with Service Portal</strong></td>
<td>Design a portal interface that lets your users browse options, discover articles, or get help.</td>
</tr>
<tr>
<td><strong>Improve agent efficiency with Agent Workspace</strong></td>
<td>Enable your agents to work on multiple issues concurrently with an intuitive layout.</td>
</tr>
</tbody>
</table>
Automate work with Flow Designer

Turn business processes into digital workflows to deliver more intuitive experiences by extending ServiceNow solutions or building new workflow apps with no-code development tools.
Connect your enterprise with IntegrationHub

Connect your systems and apps using Now Platform APIs and tools. Use the ServiceNow Store to get access to an entire ecosystem of innovation for enterprise software.
Create engaging app experiences with Service Portal
With Service Portal, you can deliver your apps to employees through a portal that they can access from any device, at any time.

**Improve agent efficiency with Agent Workspace**

Solve issues faster with a workspace that is built to facilitate resolutions. From a single view, agents get full context and AI-assisted recommendations to resolve issues quickly. Agents can communicate with customers from the same interface while reviewing issues.

**Get started**

- Learn how to build your first flow. See [Getting started with flows](#)
- Review the list of available IntegrationHub spokes. See [IntegrationHub available spokes](#)
- Learn how to build your first portal. See [Understanding Service Portal](#)
- Learn how to set up and use Agent Workspace. See [Agent Workspace](#)
Applications and features

- Advanced Work Assignment
- Agent Workspace
- Configuration Management Database
- Connect
- Connections and Credentials
- Content Management System
- Dependency Views
- Data Certification
- Decision Tables
- E-Signature
- Edge Encryption
- Flow Designer
- Instance Data Replication
- IntegrationHub
- Interaction Management
- Knowledge Management
- Legacy: Chat
- Legacy Notify
- Live Feed
- Managed Documents
- MetricBase
- MID Server
- Notifications
- Notify
- Orchestration
- Password Reset application
- Retrieving external data using remote tables and scripts
- Response templates
- Self-service
- Service administration
- Service Portal
- Skills Management
- Subscription Management
- Survey Management
- Task Communications Management
- Timeline Visualizations
- Visual Task Boards
- Workflow

Advanced Work Assignment

Use the ServiceNow® Advanced Work Assignment (AWA) feature to automatically assign work items to your agents, based on their availability, capacity, and optionally, skills. AWA pushes work to qualified agents using work item queues, routing conditions, and assignment criteria that you define. Agents see their assignments in their Agent Workspace inbox.
Customers use different channels to request service, for example, chats, cases, or incidents. Requests from customers create task or interaction records that store information about these objects, called work items.

AWA automatically routes work items to queues that focus on certain types of support, using criteria (such as priority or customer status) that you provide. Queues can be defined based on need or type, for example product or critical cases. You also identify the agent groups responsible for work in the queue. AWA then applies assignment rules that you set and uses agent availability, capacity, and skills (if defined) to assign work to the most qualified agent.

Advanced Work Assignment components

Service channels
A means of providing customer service. AWA offers base system channels for chats, cases, incidents, and walk-up centers. For each channel, you can set attributes such as agent capacity and utilization conditions to control the work handled in the channel.
Work items
A single piece of work to be handled by an agent from start to completion. For example, one chat or one case are objects that are routed and assigned to agents.

Work item queues
A queue stores a specific type of work item for a service channel. AWA admins can create queues that focus on certain types of support within the channel, such as VIP customers or critical cases. AWA routes work items to queues based on specific conditions or requirements that you define, such as customer status, or region. Groups assigned to each queue handle the incoming work items. Once work items are placed in a queue, AWA can then assign items to available agents based on assignment rules and agent availability and capacity.

Assignment groups
Agents belong to specific groups that are organized by the type of work assigned to them. You provide details about an assignment group including the name and description, manager, and group email. You can also set up roles, groups and group members, queues, and agent capacity overrides for agents in an assignment group.

Assignment rule
Criteria that determines how work items are pushed to the appropriate agent within a qualified assignment group.

Agent capacity
The maximum number of work items on a particular service channel that an agent may actively work on at one time.

Agent availability
States that indicate agent presence and whether the agent is available for work or is busy or offline. AWA uses the agent availability state to determine if an agent is able to receive work.

Inbox layout
A configuration tied to a service channel that defines which fields of a record representing a work item are shown in agent inboxes. A layout defines what the agent sees in Agent Workspace.

Advanced Work Assignment roles
AWA adds the following roles for users who configure, manage, and receive work assignments.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA administrator [awa_admin]</td>
<td>Admin role for the AWA feature. Configures and administers across all channels.</td>
</tr>
<tr>
<td>AWA agent [awa_agent]</td>
<td>Agent role for the AWA feature. Handles customer interactions and manages workload across multiple service channels.</td>
</tr>
<tr>
<td>AWA developer [awa_integration]</td>
<td>Developer role for using the AWA API.</td>
</tr>
</tbody>
</table>
Basic process for configuring AWA

Users with the awa_admin role determine:

- What to route – Configure the base service channels to be used.
- Where to route – Define the work item queues and the routing rules, execution order, work item sort order, and strategy
- How to assign work items – Define the assignment rules that determine the work items pushed to agents
- What the agent sees – Set the inbox card layouts and presence (availability) states that agents use in their Agent Workspace inbox.

For details on the AWA components and related configuration, see these sections.

Get started with Advanced Work Assignment

To implement Advanced Work Assignment, complete these initial configuration and setup steps.

Role required: awa_admin and admin

1. Activate the Advanced Work Assignment plugin for your instance.
2. Activate related AWA plugins to enable base system service channels and the Performance Analytics Solution for AWA. For example, activate the Agent Chat plugin to enable the Chat service channel and Agent Chat in Agent Workspace.
3. Configure the service channels that you activated.
   - Create or modify an inbox layout.
   - Override agent capacity as needed.
4. Create agent groups to which work items are assigned.
5. Create work item queues for your service channels.
   - Define the pools of agents eligible for assignment (eligibility assignment).
   - Set the sort order for work items in the queue.
6. Configure the work assignment rules used to push work to the appropriate agents.
7. Set the controls that agents use to manage their availability states and assignments in Agent Workspace.
   - Create or update the presence states that agents use to indicate their availability.
   - Create or update the reasons that agents use to decline work assignments.

Activate Advanced Work Assignment

You can activate the Advanced Work Assignment plugin (com.glide.awa) if you have the admin role.

Role required: admin

Advanced Work Assignment activates the Skills Management [com.snc.skills_management] plugin to implement user and group skills.
Plugins for

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skills Management</td>
<td>Implements user and user group skills. Based on the same principles of roles management, which uses inheritance between user groups.</td>
</tr>
</tbody>
</table>

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, they will receive the following error: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.*

Activate the related AWA plugins to enable the appropriate service channels and the Out-of-the-box Performance Analytics Solutions for Advanced Work Assignment.

**Activate related plugins for Advanced Work Assignment**

After activating the Advanced Work Assignment plugin, activate related AWA plugins to enable other base system service channels and the Performance Analytics Solutions dashboard for AWA.

You must have the admin role to activate these additional plugins for AWA. For details, see [Activate a plugin](#).

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Chat [com.glide.interaction.awa]</td>
<td>Enables the Chat service channel in AWA and chat messaging in Agent Workspace. Includes default configuration data for chats, including demo data.</td>
</tr>
<tr>
<td>Advanced Work Assignment for CSM [com.snc_csm.awa]</td>
<td>Enables the Case service channel in AWA. Includes configuration data supporting routing, queuing, and assignment of CSM cases.</td>
</tr>
<tr>
<td>Advanced Work Assignment for Incidents [com.snc.incident.awa]</td>
<td>Enables the Incident service channel in AWA. Includes a default configuration to support AWA for incidents.</td>
</tr>
<tr>
<td>Walk-up Experience [com.snc.walkup]</td>
<td>Activates the walk-up contact service channel for prebuilt tech lounges. Enables an IT organization to support online and offsite checkin.</td>
</tr>
<tr>
<td>Performance Analytics Content Pack – Advanced Work Assignment [com.snc.pa.awa]</td>
<td>Activates the Performance Analytics Content Pack for AWA. Provides base system KPIs.</td>
</tr>
</tbody>
</table>
Migrate from Connect Support to Advanced Work Assignment and Agent Chat

Agent Chat (live chat) is the real-time messaging system that agents use in Agent Workspace to interact with customers. To migrate from Connect Support, use AWA to create the chat queues used for routing chat work items to agents and the Chat Setup form to configure Agent Chat.

Role required: admin

1. Activate the Advanced Work Assignment and Agent Chat plugins if they are not currently active.
2. If needed, review your existing Connect Support chat queues and determine whether you want to create a similar set of queues for the Chat service channel in AWA.

   **Note:** You cannot use your Connect Support chat queues in AWA. Chat queues for Connect Support are stored in the Chat Queue [chat_queue] table, while chat queues for AWA are stored in the AWA Queue [awa_queue] table.

3. In AWA, configure the Chat service channel and create the associated chat queues.
4. In the Chat Setup form, specify Agent Workspace as the fulfiller interface for live chat.
   a) Navigate to **Collaboration > Chat Setup**.
   b) In the **Global Fulfiller UI** choice list or the **Fulfiller UI** choice list for CSM or ITSM, select Agent Workspace.
   c) Click **Update**.

Components installed with Advanced Work Assignment

Several types of components are installed with activation of the Advanced Work Assignment plugin, including tables, user roles, and scheduled jobs.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Work Assignment administrator</td>
<td>Admin role for the AWA feature. Configures and manages AWA.</td>
<td>• awa_manager</td>
</tr>
<tr>
<td>[awa_admin]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Work Assignment developer</td>
<td>Developer role for the AWA feature. Uses the AWA integration APIs.</td>
<td>None</td>
</tr>
<tr>
<td>[awa_integration_user]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Work Assignment agent</td>
<td>Agent role for the AWA feature. Handles customer interactions and manages</td>
<td>None</td>
</tr>
<tr>
<td>[awa_agent]</td>
<td>workload across multiple service channels</td>
<td></td>
</tr>
</tbody>
</table>
## Role title [name]

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Work Assignment manager [awa manager]</td>
<td>Manager role for the AWA feature. Monitors performance of agents across all service channels.</td>
<td>None</td>
</tr>
</tbody>
</table>

## Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA WorkItem TimeOut Job</td>
<td></td>
</tr>
<tr>
<td>AWA Cleanup Job</td>
<td></td>
</tr>
</tbody>
</table>

## Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA Agent Capacity [awa_agent_capacity]</td>
<td>Stores capacity override records for agents on individual channels.</td>
</tr>
<tr>
<td>AWA Agent Channel Availability [awa_agent_channel_availability]</td>
<td>Store the records that determine the agents available in the channel.</td>
</tr>
<tr>
<td>AWA Agent Presence [awa_agent_presence]</td>
<td>Stores the records that define the agent availability state.</td>
</tr>
<tr>
<td>AWA Agent Presence History [awa_agent_presence_history]</td>
<td>Stores records on agent presence state changes.</td>
</tr>
<tr>
<td>AWA Assignment Rule [awa_assignment_rule]</td>
<td>Stores the assignment rule records used to determine the work items pushed to agents.</td>
</tr>
<tr>
<td>AWA Eligibility Pool [awa_eligibility_pool]</td>
<td>Stores the records that define grouping of agents eligible to receive work items in the queue when the items have been rejected by agents or agents are unavailable.</td>
</tr>
<tr>
<td>AWA Group Queue Priority [awa_group_queue_priority]</td>
<td>Stores the priority values for queues assigned to groups.</td>
</tr>
<tr>
<td>AWA Inbox Layout [awa_inbox_layout]</td>
<td>Defines the fields that appear on a work item card in the Agent Workspace inbox.</td>
</tr>
<tr>
<td>AWA Queue [awa_queue]</td>
<td>Stores the work item queue records.</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Description</th>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines which fields in a work item for a queue you can sort on.</td>
<td>AWA Queue Item Sorting [awa_queue_item_sorting]</td>
</tr>
<tr>
<td>Stores the records that define the reasons that agents use to decline work items assigned to them.</td>
<td>AWA Reject Reason [awa_reject_reason]</td>
</tr>
<tr>
<td>Defines the communication channel for which work items may be queued.</td>
<td>AWA Service Channel [awa_service_channel]</td>
</tr>
<tr>
<td>Stores items of work, for example, chats, cases, or incidents, that are routed from service channels to queues and then to agents.</td>
<td>AWA Work Item [awa_work_item]</td>
</tr>
<tr>
<td>Stores the rejection history records for each work item.</td>
<td>AWA Work Item Rejection [awa_work_item_rejection]</td>
</tr>
</tbody>
</table>

### Properties installed

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.awa.enabled | Enables the auto assignment of work items for Advanced Work Assignment.  
  - Type: true | false  
  - Default value: true  
  - Location: System Property [sys_properties] table |
| com.snc.awa.cache.enabled | Enables the Advanced Work Assignment cache.  
  - Type: true | false  
  - Default value: true  
  - Location: System Property [sys_properties] table |

### Domain separation in Advanced Work Assignment

This overview describes domain separation in the Advanced Work Assignment feature. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

### Overview

#### Support: Level 2

Advanced Work Assignment enables the automatic assignment of work items to qualified agents using work item queues defined for specific service channels. Managed Service Providers can create domain-specific queues by specifying a particular domain as a queue routing condition.
How domain separation works in Advanced Work Assignment

When an instance has a domain hierarchy where users and groups belong to different domains, you may need to restrict the visibility of work items to certain agents in a domain. You may also need to ensure that work items are routed to agents in the proper domain. AWA admins can configure service channels and associated work item queues to:

Route work by domains

To push work items to agents in domains where only certain tasks or interactions are visible to them, use a routing condition that routes those items to the appropriate queues. For example:

- To restrict a queue to only items that match exactly to a particular domain X, specify this condition: `[Domain] [is] [X]`
- To route all work items in domain X and its child domains to a queue, use the Domain Path field and specify a condition such as: `[Domain Path] [starts with] [!!!/!!#/]`

Assign work to agents in the appropriate domain

To assign work items to agents in the appropriate domain, ensure that the assignment groups specified in the queue Eligibility Assignment pools have agents that belong to the domains where they can see the work items routed to the queue.

If a mismatch occurs, and agents in an eligible assignment group cannot see a work item in a queue, AWA may temporarily assign an item to an agent. However, before the item is moved to the agent's inbox, AWA automatically rejects the assignment with the reason No access. AWA reassigns the work item to a different agent who might have access. If none of the available agents can see the work item, the item could be rejected multiple times. The item can get stuck in the queue until the AWA admin can correct the eligible assignment configuration.

Service channels

Provide customer support for your full range of incoming work by automatically routing work to agents through service channels.

A service channel is a means of assigning a specific type and scope work to agents. You can configure base system service channels to set the context and service channel attributes that define the work handled in the channel, or you can create your own custom service channel.

Advanced Work Assignment provides several service channels from which work items originate. These channels are:

<table>
<thead>
<tr>
<th>Service channel</th>
<th>Description</th>
<th>Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat</td>
<td>Used to route and assign chat interactions</td>
<td>Included with the Agent Chat (com.glide.interaction.awa) plugin</td>
</tr>
<tr>
<td>Case</td>
<td>Used to route and assign customer service cases</td>
<td>Included with the Advanced Work Assignment for CSM (com.sn_csm_awa) plugin</td>
</tr>
<tr>
<td>Incident</td>
<td>Used to route and assign incidents</td>
<td>Included with the Advanced Work Assignment for Incidents (com.snc.incident.awa) plugin</td>
</tr>
<tr>
<td>Walk-up</td>
<td>Used to route requests from a walk-up contact channel</td>
<td>Included with the Walk-up Experience (com.snc.walkup) plugin</td>
</tr>
</tbody>
</table>
You can also set up a custom service channel to address work that is not supported in the base system channels. For more information, see Set up a custom service channel.

For each service channel, you set attributes such as:

- Agent capacity: the amount of work that can be handled by the agents supporting the channel.
- Filters: conditions that filter the type of work handled in the channel.
- Utilization: conditions that determine when work items are generated.

For each service channel, you also:

- Create the agent inbox card layout used in Agent Workspace.
- Set capacity overrides for specific agents.
- Review and modify associated work item queues. For the Chat service channel, you can create queues using the Queues related list.

Service channel capacity and utilization

In Advanced Work Assignment, capacity is the number of work items automatically assigned to agents supporting a service channel. Utilization is the condition that identifies the work item states supported in the channel.

Agents have an assigned capacity for each service channel. This capacity is based on the default capacity set for the channel. The agent capacity for one service channel (for example, chat) does not interfere with the capacity on other service channels (for example, case or incident). Admins can set the Default capacity for a channel on the Service Channel form. This setting applies to all agents supporting the channel.

Managers can override the default capacity for:

- Individual agents, by using the Agent Capacity Override related list on the Service Channel form.
- Groups of agents, by using the Agent Capacity Override related list on the Group form.

If an agent already has a capacity override, setting the override again updates the existing capacity for that agent. Override capacity is stored in the Agent Capacity (awa_agent_capacity) table.

Inbox layout

The inbox layout determines the information shown on work item cards displayed in an agent's inbox.

The AWA admin (awa_admin) can configure layouts that represent items in an agent inbox. The configuration allows agents to see the most important attributes by service channel work items. The fields specified on the inbox layout determine the information displayed for a work item.

Each base system service channel provides preconfigured inbox layouts for work items. The AWA admin can view and edit these layouts and also create new layouts.

Up to five fields can be shown in the card layout.

- Fields can be added from the table that the service channel points to.
- The first field added to the layout becomes the title field on the card.

Layout example

For chats that do not have either a contact or consumer, the layout includes only the chat subject. You control the display of the Time to accept count (timer) and the Reject button through the agent assignment rules.
Configure a service channel

Modify or create a service channel used in Advanced Work Assignment. You can specify additional conditions to filter the work items handled in the channel, change agent capacity (workload) for the channel, set the inbox layouts that your agents use in Agent Workspace, and view associated work item queues.

Role required: awa_admin or admin

AWA provides base system channels for the following services, if you activated the corresponding plugins:

- Chats (com.glide.interaction.awa)
- Cases (com.snc_csm.awa)
- Incidents (com.snc.incident.awa)
- Walk-up interactions (com.snc.walkup)

For each channel, you can change certain default settings, such as the default capacity (workload) for agents. You can also use the related lists to review associated queues, define the associated inbox layouts (work item cards) displayed in Agent Workspace, and override the agent capacity value.

You can also create a service channel record from the Service Channel module, but you need to create a queue, assignment rule, and eligible assignment pool in order to route work through the service channel. For more information, see Set up a custom service channel.

1. Navigate to **Advanced Work Assignment > Service Channels**.
   - To create a service channel, click **New**.
   - To modify a service channel, select the service channel record to be updated.
2. Fill in or update fields on the Service Channel form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the selected base system service channel to be configured:</td>
</tr>
<tr>
<td></td>
<td>• Chat</td>
</tr>
<tr>
<td></td>
<td>• Case</td>
</tr>
<tr>
<td></td>
<td>• Incident</td>
</tr>
<tr>
<td></td>
<td>• Walk-up</td>
</tr>
<tr>
<td>Inbox order</td>
<td>The order in which channel items are displayed in the agent inbox.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the service channel:</td>
</tr>
<tr>
<td></td>
<td>• Chat: Live Agent Chat Interactions</td>
</tr>
<tr>
<td></td>
<td>• Case: Cases for Agents</td>
</tr>
<tr>
<td></td>
<td>• Incident: Incidents for Agents</td>
</tr>
<tr>
<td></td>
<td>• Walk-up: Walk-up interactions for agents to work on</td>
</tr>
<tr>
<td>Table</td>
<td>The table that stores the service channel records:</td>
</tr>
<tr>
<td></td>
<td>• Chat: Interaction [interaction]</td>
</tr>
<tr>
<td></td>
<td>• Case: Case [sn_customerservice_case]</td>
</tr>
<tr>
<td></td>
<td>• Incident: Incident [incident]</td>
</tr>
<tr>
<td></td>
<td>• Walk-up: Interaction [interaction ]</td>
</tr>
<tr>
<td></td>
<td>• Custom: any Task [task] or Interaction [interaction] table</td>
</tr>
<tr>
<td>Advanced condition</td>
<td>If enabled, the advanced conditions that apply to the channel. For example:</td>
</tr>
<tr>
<td></td>
<td>• Chat: [Type] [is] [Chat]</td>
</tr>
<tr>
<td></td>
<td>• Walk-up: [Type] [is] [Walk-up]</td>
</tr>
<tr>
<td>Application</td>
<td>The name of the application.</td>
</tr>
<tr>
<td></td>
<td>• Chat: Global</td>
</tr>
<tr>
<td></td>
<td>• Case: Advanced Work Assignment for CSM</td>
</tr>
<tr>
<td></td>
<td>• Incident: Advanced Work Assignment for Incidents</td>
</tr>
<tr>
<td></td>
<td>• Walk-up: Walk-up Experience</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for activating the service channel. When this box is checked, the</td>
</tr>
<tr>
<td></td>
<td>associated queues for the service channel can start accepting work items.</td>
</tr>
<tr>
<td>Assign to field</td>
<td>The field in the table that references the user that the item is assigned to.</td>
</tr>
<tr>
<td></td>
<td>In both Case and Interaction (and most other tables), this is the Assigned to field:</td>
</tr>
<tr>
<td></td>
<td>(assigned_to) field.</td>
</tr>
<tr>
<td>Assignment group field</td>
<td>The field in the table that references the assignment group that the item is assigned to. In most tables, this is the Assignment group field.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field | Definition
--- | ---
**Default capacity** | The number of items automatically assigned to agents (pending overrides).
  * Chat: the default is 4.
  * Case and Incident: the default is 2.
  * Walk-up: 1

**Utilization condition** | Condition that determines what constitutes an active item that counts toward agent workload/capacity (for example, the record state is New, Open, or Awaiting Info).
  * For chat: State is not one of On Hold, New, Work in Progress, Closed Complete
  * For case: State is one of New, Open
  * For incident: State is one of New, In Progress, On Hold
  * For walk-up: State is not one of On Hold, Closed Complete, or Closed Abandoned

3. Click **Update**.
   The channel is added to or updated in the Service Channels [awa_service_channel] table.

As needed:
- Override the agent capacity for selected agents or groups.
- Create or modify an inbox layout for the service channel.
- Configure agent assignment rules for the channel.
- Define agent pools eligible for assignment.
- Create or modify a work item queue for the channel.

### Set up a custom service channel

Set up a custom service channel to expand the type and scope of work that is routed automatically to your agents.

- Select the table that you want to use to route work to agents automatically. Only Task [task] and Interaction [interaction] tables are supported.
- Ensure that the form layout for the selected table is configured for the workspace view. Record types without a workspace view appear as read-only in Agent Workspace. For more information, see Configure the form layout for Agent Workspace.
- Assign the awa_agent and workspace_agent roles to whichever agents are receiving work items in Agent Workspace from your custom service channel.

**Role required:** awa_admin or admin

You can create a service channel record from the Service Channel module, but you need to create a work item queue, assignment rule, and eligible assignment pool to route work through the service channel. You also need to configure the custom service channel to make it available in an agent's inbox in Agent Workspace.

1. Navigate to **Advanced Work Assignment > Service Channels**, and then click **New**.
2. Complete the service channel fields, and then click **Submit**.
   For more information, see Configure a service channel.
3. Create an assignment rule.
   For more information, see Configure agent assignment rules.

4. Create a work item queue for your service channel.
   For more information, see Create a work item queue.

5. On the form for the work item queue that you created, go to the Assignment Eligibility related link
   and create an eligible assignment pool.
   Make sure to associate your assignment rule to the eligible assignment pool.
   For more information, see Define agent pools eligible for assignment.

6. Make your service channel available in Agent Workspace.
   a) Navigate to Advanced Work Assignment > Presence States, and then open Available.
   b) On the form, move your custom service channel to the Selected list.
   c) Select Active option (if not already selected).
   d) Click Update.

7. Optional: Create or modify the inbox card layout to show the most important information from a work item.
   For more information, see Create or modify an inbox layout.

Your custom service channel routes work to agents. In Agent Workspace, the service channel appears as an available service channel in the agent inbox.

**Tutorial: Set up a custom service channel for change requests**

Learn how to configure Advanced Work Assignment to automatically assign change requests to agents. Use this tutorial as a guideline to help you understand how service channel records, queues, and assignment rules work together to create a custom service channel.

In this tutorial, you learn how to set up a custom channel that:

- Assigns new change requests to whichever Change Management agent has the most capacity
- Populates the assignee's agent inbox in Agent Workspace with change requests from the queue
- Displays the change request number, short description, and type on the inbox card
- Enables the agent to accept or reject change requests

For information on setting up custom service channels, see Set up a custom service channel.

Before you begin:

- Ensure that the form layout for the Change Request table is configured for the workspace view; otherwise, work items from the Change Request service channel appear as read-only in Agent Workspace. For more information, see Configure the form layout for Agent Workspace.
- Assign the awa_agent and workspace_agent roles to the Change Management group so that members can open work items in Agent Workspace.

**Create a service channel to route requests**

Create a service channel in Advanced Work Assignment so that you can route change requests to agents.

Role required: awa_admin or admin

1. Navigate to Advanced Work Assignment > Service Channels, and then click New.
2. On the form, fill in the fields.
   - Name: Change Request
   - Inbox Order: 100
   - Table: Change Request [change_request]
- Active: Selected
- Utilization condition: [Active] [is] [true]

3. Click Submit.

Create an assignment rule for change requests
Create an assignment rule in Advanced Work Assignment that assigns change requests to agents who are available to do the tasks.

Role required: awa_admin or admin

1. Navigate to Advanced Work Assignment > Assignment Rules, and then click New.
2. On the form, fill in the fields.
   - Name: Change Request Assignment Rule
   - Assign by: Most Capacity
   - Allow agents to reject: Selected

3. Click Submit.

Create a queue to route new change requests
Create a work item queue in Advanced Work Assignment that routes new change requests through the service channel that handles change requests.

Role required: awa_admin or admin

1. Navigate to Advanced Work Assignment > Queues, and then click New.
2. On the form, fill in the fields.
   - Name: Change Management
   - Service channel: Change Request
   - Condition mode: Simple
   - Work item routing condition: [State] [is] [New]

3. From the form context menu, click Save.

Create an assignment pool of agents
Create an eligible assignment pool in Advanced Work Assignment that receives overflow work items, just in case you need more help from other agents to handle change requests.

Role required: awa_admin or admin

1. Navigate to Advanced Work Assignment > Queues, and then open the Change Management queue.
2. On the form, go to the Assignment Eligibility related list and click New.
3. On the form, fill in the fields.
   - Agent assignment rule: Change Request Assignment Rule
   - Groups: Change Management

4. Click Submit.

Make your service channel available in Agent Workspace
Make your service channel available in Agent Workspace so that agents can receive change requests in their inbox.

Role required: awa_admin or admin

1. Navigate to Advanced Work Assignment > Presence States, and then open Available.
2. On the form, move Change Request to the Selected list.
3. Select **Active** (if not already selected).
4. Click **Update**.

*Customize how change requests appear in an agent inbox*

Customize how change requests appear in an agent inbox so that agents receive enough information to decide whether to accept or reject the work item.

**Role required:** awa_admin or admin

1. Navigate to **Advanced Work Assignment > Service Channels** and open the **Change Request** service channel record.
2. On the Change Request service channel form, go to the **Inbox Layouts** related list and open **Default Change Request layout**.
3. On the form, fill in the fields.
   - Field 1: Number
   - Field 2: Short description
   - Field 3: Type
4. Click **Update**.

When you create a new change request, the item is routed through the Change Request service channel and assigned to the agent in the Change Management assignment group who is available to receive the change request. When the assignee checks their agent inbox, the change request appears with the option for the agent to either reject or accept the work item.

---

**Create or modify an inbox layout**

Create or modify the card layout for inbox items for a given service channel. Card layouts are displayed in the agent inbox view of Agent Workspace.
Role required: awa_admin or admin. Users with the awa_manager or agent role can review inbox layouts.

Cards represent work items in an agent's inbox in Agent Workspace. Each channel has a default layout for these cards, which can display up to five fields from the related table record. Use the Inbox Layout form to change a default layout, such as the name, short description, and the specific fields displayed on the card, for example channel and contact or consumer name. You can also specify certain conditions that determine when the card layout is used.

1. Navigate to Advanced Work Assignment > Service Channels and select the service channel to be updated.
2. In the Service Channel form, click the Inbox Layouts related link.
   - To create a layout, click New.
   - To modify a layout, select the layout to be updated.
3. Fill in or modify the Inbox Layout form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the inbox layout.</td>
</tr>
<tr>
<td>Service channel</td>
<td>The name of the selected service channel.</td>
</tr>
<tr>
<td>Short description</td>
<td>The description of the inbox layout.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the layouts appear in the agent inbox.</td>
</tr>
<tr>
<td>Condition</td>
<td>A condition that determines when this layout is used. Use the condition builder to specify a condition that must evaluate to true to apply the layout.</td>
</tr>
<tr>
<td>Card layout</td>
<td>Example card layout.</td>
</tr>
<tr>
<td>Field 1</td>
<td>The field from the table for the channel, for example the Interaction [interaction] table for the chat service channel. Select the field or select None to remove an existing field.</td>
</tr>
<tr>
<td>Field 2</td>
<td>The field from the table for the channel, for example the Interaction [interaction] table for the chat service channel. Select the field or select None to remove an existing field.</td>
</tr>
<tr>
<td>Field 3</td>
<td>The field from the table for the channel, for example the Interaction [interaction] table for the chat service channel. Select the field or select None to remove it.</td>
</tr>
<tr>
<td>Field 4</td>
<td>The field from the table for the channel, for example the Interaction [interaction] table for the chat service channel. Select the field or select None to remove it.</td>
</tr>
<tr>
<td>Field 5</td>
<td>The field from the table for the channel. For example, the Interaction [interaction] table for the Chat service channel. Select the field or select None to remove it.</td>
</tr>
</tbody>
</table>

4. Click Submit for a new layout or Update to modify a layout.
   The layout is added to or updated in the Inbox Layout [awa_inbox_layout] table.

As needed:
Override the agent capacity value for selected agents or groups.
Create or modify a work item queue for the channel.

Override agent capacity for selected agents

Change the default number of work items that an agent can handle for a service channel.

Role required: awa_manager, awa_admin, or admin

To change the capacity for selected agents, use the Agent Capacity Override related list for the service channel. To change the capacity for one or more members of a selected group, use the Agent Capacity Override related list for the group (Advanced Work Assignment > Groups).

1. Navigate to Advanced Work Assignment > Service Channels and select the desired service channel.
2. In the Agent Capacity Override related list, click New.
3. Fill in the fields on the Change Agent Capacity (Service Channel) form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Channel</td>
<td>The name of the selected channel.</td>
</tr>
<tr>
<td>Override Capacity</td>
<td>The number of work items that the selected agents can handle.</td>
</tr>
<tr>
<td>Users</td>
<td>The agents to which this override applies. Move the agent names from the Available list to the Selected list. You can use the filter to identify conditions that restrict the list of agents.</td>
</tr>
</tbody>
</table>

Note: The filter shows only users or groups that have AWA roles (awa_agent, awa_manager, awa_admin, admin).

4. Click Submit.

The selected agents and their associated capacity values are listed in the Agent Capacities table.

If you are configuring a service channel, you can create or change an inbox layout for the channel.

Work item queues

In Advanced Work Assignment, queues store a specific type of work item for a service channel.

AWA administrators can create or modify queues based on customer need. As part of creating or modifying a queue, the awa_admin identifies some information about the queue, including the service channel to which the queue belongs and which agent groups handle the incoming work items.

In addition, the awa_admin can select a schedule that defines when the queue is available and identify a time limit within which an agent should accept a work item in the queue. If the selected service channel is Chat, the awa_admin creates the chat messages that are displayed to users.

Routing conditions identify the work items that are routed to a queue. Create routing conditions in one of two ways:

- Simple: use a condition builder to select routing conditions. The fields available for selection are based on the selected service channel.
• Advanced: use a JavaScript script to identify routing conditions.

The awa_admin can also create a queue without routing conditions so that work items are not automatically routed to that queue. Customers can manually assign work items to the queue or assign work items using assignment tools such as matching rules or flow designer.

When a case in a queue is manually assigned, the case is removed from the queue. The state of the work item is set to Canceled and the cancellation reason is set to Manually assigned.

Note: New work items may not be assigned if they are routed to queues containing more than 10,000 work items in the queued state.

Assign pools of agents eligible to work on a queue

Assign one or more agent groups to a queue using the Eligibility Assignment related list. These groups are eligible to receive work items from the queue, which allows work to get prioritized to eligible agents.

For each group, select an agent assignment rule and any eligibility time constraints, which are used to determine when the next pool of agents is eligible for assignment. For example, you can assign one group to handle work items immediately and assign a second group to handle the overflow from the first group after work items sit in the queue for a specified amount of time.

Note: If no groups are assigned to a queue, work items can be routed to the queue but are not assigned by Advanced Work Assignment.

Create a sort order for a queue

Use the Work Item Sort Order related list to create one or more sort conditions for work items in a queue. For each sort condition, specify a field from the selected service channel table and the direction to sort, either ascending or descending. Items in the queue are sorted and assigned to agents based on these conditions.

Create a work item queue

Define or modify a queue so that you can determine which specific work items are routed automatically to agents through a given service channel.

Role required: awa_admin or admin

Depending on the service channel, additional configuration options are available. For example, in the chat channel you define the standard messages displayed during a chat session with a user.

1. Navigate to Advanced Work Assignment > Queues.
   • To create a queue, click New.
   • To modify a queue, select the queue record to be updated.

2. Fill in or update the fields on the Queues form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the queue. A default queue may be available for the service channel you activated through the AWA-related plugins.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service channel</td>
<td>The channel to which the queue belongs. For the chat channel, define the standard messages displayed to chat users in the Chat Messages section.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box indicating whether the queue is enabled.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief explanation of the queue.</td>
</tr>
<tr>
<td>Schedule</td>
<td>The support schedule that defines when the queue is available.</td>
</tr>
<tr>
<td>Order</td>
<td>During routing, the order in which AWA considers the routing condition for this work item queue, in comparison to other queues.</td>
</tr>
<tr>
<td>Target wait time</td>
<td>The estimated time (Days or Hours, minutes, seconds) allotted for an agent to accept an item in the queue.</td>
</tr>
<tr>
<td>Max Wait Time</td>
<td>Maximum amount of time that an agent has to accept or reject a chat request. After time runs out, the requester receives the <strong>No Agents Available Message</strong> that is defined in Chat Setup.</td>
</tr>
<tr>
<td>Note: The Max Wait Time field is available after you associate the queue to the chat service channel.</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>The type of scoped application.</td>
</tr>
<tr>
<td>Routing Condition</td>
<td></td>
</tr>
<tr>
<td>Define condition here</td>
<td>Check box that indicates a routing condition is to be applied to the queue. If checked, define the <strong>Condition mode</strong> and <strong>Work item routing condition</strong>.</td>
</tr>
<tr>
<td>Condition mode</td>
<td>The type of condition for routing work items in the queue.</td>
</tr>
<tr>
<td></td>
<td>• Simple: Specify a routing condition using the condition builder.</td>
</tr>
<tr>
<td></td>
<td>• Advanced: Specify a JavaScript scripted condition.</td>
</tr>
<tr>
<td>Work item routing condition</td>
<td>The condition that applies to the work items in this queue. Use the condition builder to select routing conditions. The fields available for selection are based on the selected service channel.</td>
</tr>
<tr>
<td>Script</td>
<td>JavaScript condition statement that specifies the work items to be routed to the queue. The condition must evaluate to true.</td>
</tr>
<tr>
<td>Chat Messages</td>
<td>For the chat service channel.</td>
</tr>
</tbody>
</table>
### Field | Definition
--- | ---
**Question** | Initial phrase that users see when they start a new chat in the queue. For example: How can we help you?  
**Confirm problem** | Message to users acknowledging the chat request. For example: Thank you for contacting support. Someone will be with you shortly to assist you.  
**Initial agent response** | Message that users see when an agent accepts a chat. For example: Thank you for contacting support. I am looking into your question now and will be with you shortly.

3. **Click Submit** for a new queue or **Update** to modify the queue. The queue is added to or updated in the Queues [awa_queue_list] table.

As needed:
- Define the **Assignment Eligibility**.
- Optionally define the **Work Item Sort Order**.

### Define agent pools eligible for assignment

Specify pools of agents eligible to receive overflow work assignments for a queue. An eligible assignment pool can consist of one or more groups of agents available to work on items in the queue. This feature enables AWA to find a qualified agent from a wider pool of agents.

**Role required:** admin

Use the **Assignment Eligibility** related link to expand the pool of agents eligible to work on items in the queue when other agents are busy or unavailable. For each agent pool, select the assignment rule that determines the assignment eligibility. If you do not define an eligible assignment pool for a queue, work items are routed to the queue but AWA does not assign them.

1. **Navigate to** Advanced Work Assignment > Queues and in the Queues [awa_queues] table, click the queue to update.
2. **To create an assignment pool,** go to the Assignment Eligibility related link.
   - To create a new eligible assignment pool, click **New**.
   - To modify the assignment eligibility for a pool of agents, select the pool to be updated.
3. **Fill in or update the Assignment Eligibility form.**

### Field | Definition
--- | ---
**Agent assignment rule** | The name of the rule that determines how work items are to be assigned. Select an assignment rule from the list.
**Eligible at** | The length of time in seconds before AWA considers the next set of agents for assignment.
### Set work item sort order

Specify the order in which work items in a queue are sorted.

Role required: awa_admin or admin

1. Navigate to **Advanced Work Assignment > Queues > Module** and select the queue.
2. Click the **Work Item Sort Order** related list and click **New**.
3. In the Work Item Sort Order form, select:
   a) **Field**: The field to be used for the sort. The fields are from the table for the associated channel. For example, the fields available for the chat service channel are from the Interaction table.
   b) **Sort Direction**: The order in which work items are sorted. Select either Ascending (smallest to largest or oldest to newest) or Descending (largest to smallest or newest to oldest).
   c) **Order**: The value of the **Order** value relative to other items in the queue.
4. Click **Submit**.

### Tutorial: Route interactions by context

Learn how you can configure Advanced Work Assignment to route conversations to agents according to the context of the conversation.

Activate the Customer Service Management Demo Data (com.snc.customerservice.demo) plugin.

A basic understanding of context variables is required. For more information on context variables, see Virtual Agent scripts.

Role required: awa_admin or admin

The **What can we help you with?** record producer is available by default with the Customer Service Management Demo Data (com.snc.customerservice.demo) plugin. In the record producer, chat requesters can specify one of three issue categories that they need help with:

- Product
- Billing
- Order

Whichever category they select passes a value through the **liveagent_csp_category** context variable. Learn how to create queues that route conversations to agents according to the values passed through this context variable.

### Create a queue for product issues

Create a queue for the Chat service channel that routes product issues.

1. Navigate to **Advanced Work Assignment > Queues**, and then click **New**.
2. Enter the following information in the fields listed:
   • Name: Product Support
   • Service channel: Chat
   • Condition mode: Advanced

3. In the **Script** field, enter this script:

   ```javascript
   (function executeCondition(/* glide record */ current) {
     var contextTable = current.getValue('context_table');
     var interactionBlobRecord = new GlideRecord(contextTable);
     interactionBlobRecord.addQuery('sys_id', current.getValue('context_document'));
     interactionBlobRecord.query();
     if (interactionBlobRecord.next()){ 
       var jsonBlob = JSON.parse(interactionBlobRecord.getValue('value'));
       if (jsonBlob.liveagent_csp_category == 'product')
         return true;
     }
     return false;
   })(current);
   ```

4. Click **Submit**.

**Create a queue for billing issues**

Create a queue for the Chat service channel that routes billing issues.

1. From the Queues list view, click **New**.
2. Enter the following information in the fields listed:
   • Name: Billing Support
   • Service channel: Chat
   • Condition mode: Advanced

3. In the **Script** field, enter this script:

   ```javascript
   (function executeCondition(/* glide record */ current) {
     var contextTable = current.getValue('context_table');
     var interactionBlobRecord = new GlideRecord(contextTable);
     interactionBlobRecord.addQuery('sys_id', current.getValue('context_document'));
     interactionBlobRecord.query();
     if (interactionBlobRecord.next()){ 
       var jsonBlob = JSON.parse(interactionBlobRecord.getValue('value'));
       if (jsonBlob.liveagent_csp_category == 'billing')
         return true;
     }
     return false;
   })(current);
   ```

4. Click **Submit**.

**Create a queue for order issues**

Create a queue for the Chat service channel that routes order issues.

1. From the Queues list view, click **New**.
2. Enter the following information in the fields listed:
   • Name: Order Support
   • Service channel: Chat
• Condition mode: Advanced

3. In the Script field, enter this script:

```javascript
(function executeCondition(/* glide record */ current) {
    var contextTable = current.getValue('context_table');
    var interactionBlobRecord = new GlideRecord(contextTable);
    interactionBlobRecord.addQuery('sys_id', current.getValue('context_document'));
    interactionBlobRecord.query();

    if(interactionBlobRecord.next()){
        var jsonBlob = JSON.parse(interactionBlobRecord.getValue('value'));
        if(jsonBlob.liveagent_csp_category == 'order')
            return true;
    }
    return false;
})(current);
```

4. Click Submit.

Work assignments

After routing work items to the appropriate queues and corresponding agent groups, Advanced Work Assignment pushes work to the most qualified agent using the assignment criteria that you specify.

Administrators can choose to push work items to agents based on one of these assignment rules:

• Most capacity: This option pushes work to agents that have the most capacity (availability for work) for a given channel. For example, suppose that two available agents, John and Beth have different capacities. John has capacity for three chats, but Beth has capacity for two chats and is currently working on one chat. AWA assigns the next work item to John since he has the most capacity.
• Last assigned: This option pushes work to the agent who has gone the longest without a work assignment in the service channel. If more than one agent has the same spare capacity in a service channel, AWA creates and assigns the next work item to the agent who has gone the longest without work in the service channel.

In addition to selecting the assignment rule, AWA admins can also determine whether:

• Agents can reject work items
• A timer is used to set a timeout period (the length of a time that an agent has to reject or accept a work item)
• Agent skills are to be considered in assignment

Assignment process

When an agent is available, AWA:

• Checks the queue priority and gets an item from the queue with the highest priority. AWA also reviews items that have timed out or have been rejected by agents.
• Identifies the eligible assignment pool. The eligibility assignment pool widens the group of agents who are eligible to work on an item.
• Determines the available agents based on their presence state, the assignment rule selected (most capacity or last assigned), and also skills, if defined. Agents have spare capacity when they decline, transfer, or complete a work item. For example, after an agent transfers a chat, the agent has additional capacity.
• Pushes the item to the inbox of most qualified agent (the timer begins).
Skill-based work assignment

In AWA, you can enable skill-based assignment and if needed, make skill assignment mandatory. The basic process for setting up skills involves the following steps:

1. Identify agents that have specific skills (for example, a foreign language or expertise in a certain area such as network routers) and assign the skills to those agents using the Skills Management feature.
2. Make the agents members of the assignment groups for the work item queues involving those skills.
3. Create an assignment rule in AWA that enables mandatory skill handling for the specific skills.
4. Create the work item queue with a routing condition that includes the specific skill, and include the appropriate group in the eligible assignment pool.
5. Create a scripted business rule that includes the skill in the table associated with the relevant service channel (for example, the Case table).

During work assignment, AWA routes and assigns work items that require the mandatory skills to the Agent Workspace inbox of the most qualified agent.

Configure agent assignment rules

Set the criteria for assigning work items to agents. Choose the assignment rule that considers the agent with the most capacity or the agent who has gone the longest without work. Select the timeout period for rejecting work items and indicate whether agent skills are to be considered during assignment.

- A basic understanding of the Skills Management feature is recommended.
- If you want agent skills to be considered when work is routed to the appropriate agents, define the skills for your agents or groups. When you enable the skill handling options in the Assignment Rules form, AWA assigns the users in groups with the appropriate skills to corresponding work items.
- You can use rules to identify skills and assign it to work items. For more information on defining and assigning skills for work items, refer to Using rules to identify skills for work items

Role required: admin or awa_admin

1. Navigate to Advanced Work Assignment > Assignment Rules.
   - To create a new rule, click New.
   - To modify a rule, select the layout to be updated.

2. Fill in or update the fields on the Assignment Rule form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the assignment rule.</td>
</tr>
<tr>
<td>Application</td>
<td>The name of the application to which this assignment rule belongs. The default application is Global.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the assignment rule.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Assign by</strong></td>
<td>The type of assignment. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Last Assigned: Routes a work item to the agent who has gone the longest without being assigned work.</td>
</tr>
<tr>
<td></td>
<td>• Most Capacity: Routes a work item to the agent who has the greatest availability for handling the work.</td>
</tr>
<tr>
<td><strong>Rejection handling</strong></td>
<td>Check boxes for specifying how work items are rejected and handled.</td>
</tr>
<tr>
<td></td>
<td>• Allow agents to reject: Enable agents to reject work items in their inbox.</td>
</tr>
<tr>
<td></td>
<td>• Reassign on timeout: Enable reassignment of work items not accepted or rejected by agents within the specified timeout period:</td>
</tr>
<tr>
<td></td>
<td>• Timeout value (Days and Hours, Minutes, Seconds): Length of time allowed for an agent to accept or reject a work item before the assignment times out (ends) and is reassigned to another agent.</td>
</tr>
<tr>
<td></td>
<td>• Timeout presence state: The agent availability state after the timeout occurs: Available, Away, or Offline.</td>
</tr>
<tr>
<td><strong>Skill handling</strong></td>
<td>Check boxes that enable skill-based work assignments:</td>
</tr>
<tr>
<td></td>
<td>• Enable skills: Route work items to agents with the appropriate skills.</td>
</tr>
<tr>
<td></td>
<td>• Enforce mandatory skills: Route work items to agents with mandatory (required) skills.</td>
</tr>
</tbody>
</table>

3. Click **Submit** for a new rule or **Update** if modifying the rule. The assignment rule is added to or updated in the Assignment Rules [awa_assignment_rule] table.

**Tutorial: Assign work to agents by skill**

Learn how you can configure Advanced Work Assignment to route cases to agents who speak German. Use this tutorial as a guideline to help you understand how you can route work items to agents according to their designated skills.

Before you begin:

- Activate the Skills Management (com.snc.skills_management) plugin.
- A basic understanding of the Skills Management feature is required.
- To have skills automatically assigned to cases, consider activating the Skill Determination (com.snc.skill_determination) plugin.
- Create a group of users who work in customer support.
- Assign the awa_agent and workspace_agent roles to the customer support group.
Create a skill

Create a "German" skill.
Role required: skill_admin or admin
1. Navigate to Skills > All Skills, and then click New.
2. Enter the following information in the fields listed:
   • Name: German
   • Active: Selected
3. Click Submit.

Create an assignment rule

Create an assignment rule that routes cases according to skills.
Role required: awa_admin or admin
1. Navigate to Advanced Work Assignment > Assignment Rules, and then click New.
2. Enter the following information in the fields listed:
   • Name: Case Assignment Rule with Skills
   • Assign by: Most Capacity
   • Enable skills: Selected
   • Enforce mandatory skills: Selected
3. Click Submit.

Create a queue

Create a queue where you can route work to agents who have the German skill.
Role required: awa_admin or admin
1. Navigate to Advanced Work Assignment > Queues, and then click New.
2. Enter the following information in the fields listed:
   • Name: German Cases
   • Service channel: Case
3. Click Submit.

Define assignment eligibility

Define who is eligible to receive cases from the German Cases queue.
Role required: awa_admin or admin
1. Navigate to Advanced Work Assignment > Queues, and then open the German Cases queue.
2. On the form, go to the Assignment Eligibility related link and click New.
3. In the Agent assignment rule field, select Case Assignment Rule with Skills.
4. In the Groups field, select your customer support group.
5. Click Submit.

Cases that require German speakers are routed to users in your customer support group who have the German skill.
Agent Inbox controls

Control certain elements of the agent experience in Agent Workspace. Define the agent presence (availability) states and the work item rejection reasons used by agents to decline work assignments in their Agent Workspace inbox.

Agent presence states

Agent availability in Agent Workspace Inbox

AWA admins can define the presence states that agents choose in their inbox to indicate their availability. The default states are

- Available: Solid green bubble indicates that the agent is available to receive work.
- Away: Solid yellow bubble indicates that the agent is not available to receive work.
- Offline: Solid grey bubble indicates that the agent is not available to receive work.

AWA developers with the awa_integration_user role can also use JavaScript or REST APIs to get or set agent presence and agent channel availability. For more information, see

- Agent Presence API (REST APIs)
- Agent - Global (JavaScript APIs)

Agent rejection controls

AWA admins can give agents the option to reject work assignments and specify the reason for rejecting it. The Reject button displays on work assignment cards. When an agent rejects an assignment, a pop-up window enables the agent to select a reason for declining the work item.
Configure agent presence states

Create or modify the availability states that agents use to indicate whether they can receive work or are offline or away. Agents set these states in their Agent Workspace Inbox.

Role required: awa_admin or admin. Users with the awa_manager and awa_agent roles can review the presence states.

The default presence states are Available, Away, and Offline. For the Available state, be sure to enable it (using the Active check box) so that AWA can route work to agents.

1. Navigate to **Advanced Work Assignment > Presence States**.
   - To create a new presence state, click **New**.
   - To update an existing presence state, click the presence record.

2. Fill in or update the fields on the Presence State form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the presence state, for example: Out of office. The default presence states are Available, Away, or Offline.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for enabling this presence state for agents.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For the default Available state, be sure to enable this Active check box so that work items are routed to available agents. If the Active state is not enabled, AWA does not route work items to agents.</td>
</tr>
<tr>
<td>Available to receive work items</td>
<td>Check box for indicating that agents can handle work items in this presence state. If the presence state is Away or Offline, this box is not selected.</td>
</tr>
<tr>
<td>Service channels</td>
<td>The service channels that can use this presence state. To select a service channel, move the channel name from the Available list to the Selected list.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the state.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which this state is displayed in the agent inbox.</td>
</tr>
<tr>
<td>Show channels</td>
<td>Check box that enables you to restrict the service channels in which agents can update their presence using this state. When you select this field, the Restrict agent update field is displayed.</td>
</tr>
<tr>
<td>Restrict agent updates</td>
<td>The service channels in which agents cannot use this state to update their presence. Click the lock icon and select the appropriate channels. When you complete your selections, click the lock icon to lock the field.</td>
</tr>
<tr>
<td>Apply to all groups</td>
<td>Check box that indicates all groups can use this presence state. To specify only certain groups that can use this presence state, unselect this check box to display the Apply to groups list.</td>
</tr>
</tbody>
</table>
### Configure reasons for rejecting work items

Define the reasons that agents can use to decline work assignments that they receive in their Agent Workspace inbox. A reject reason can apply to all service channels or a single channel that you specify.

**Role required:** awa_admin or admin

1. **Navigate to** Advanced Work Assignment > Reject Reasons.
   - To create a new rejection reason, click **New**.
   - To update an existing rejection reason, click the reason record.
2. **Fill in or update the fields on the Reject Reason form.**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the reason for rejecting work items.</td>
</tr>
<tr>
<td>Agent selectable</td>
<td>A check box that indicates the reject reason is selectable by agents in their Agent Workspace Inbox.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the reject reasons are listed in the agent inbox.</td>
</tr>
<tr>
<td>Apply to all service channels</td>
<td>A check box that indicates the reject reason applies to all service channels. To make the reason available to a single channel, unselect this check box and in the Service channel field, select the appropriate channel.</td>
</tr>
<tr>
<td>Service channel</td>
<td>A list for selecting the service channel to which the reject reason applies. This field is displayed when Apply to all service channels is not enabled.</td>
</tr>
</tbody>
</table>

3. **Click** Submit for a new reason, or if changing an existing reason, click **Update**.
   The rejection reason is added to or updated in the Reject Reasons [awa_reject_reason] table.

### Enable logging for Advanced Work Assignment

Enable logging to monitor AWA routing and assignment.

**Role required:** awa_admin or admin

1. **In the Navigation filter,** enter sys_properties.list.
2. In the System Property [sys_properties] table, click **New** and add the `com.snc.awa.syslog.enabled` property:
   • **Name**: `com.snc.awa.syslog.enabled`
   • **Description**: Log AWA work item routing and assignments in the system log.
   • **Type**: true | false

3. Set the **Value** to true.
4. Click **Submit**.
   Logging for the AWA assignment engine is enabled in the syslog table.

### Out-of-the-box Performance Analytics Solutions for Advanced Work Assignment

Out-of-the-box Performance Analytics Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

### Enabling Performance Analytics Solutions

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

**Note**: Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.

To enable a solution for Advanced Work Assignment, an admin navigates to **System Definitions > Plugins** and activates the Performance Analytics - Content Pack - Advanced Work Assignment plugin.

### Advanced Work Assignment dashboard for interactions

Enable managers to monitor Interaction [interaction] work items so that their agents can better support customer needs.

This dashboard is available in the Advanced Work Assignment content pack. For information on activating the content pack, see Out-of-the-box Performance Analytics Solutions for Advanced Work Assignment.
Advanced Work Assignment dashboard for Interactions
End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA administrator: Configures Advanced Work Assignment to best fit the business needs of customer service.</td>
<td>awa_admin</td>
</tr>
<tr>
<td>AWA manager: Identifies the areas of concern for routing and assignment of work items across service channels.</td>
<td>awa_manager</td>
</tr>
<tr>
<td>Agent manager: Manages agents or agent groups. The agent manager needs to know what agents are working on to make sure customer needs are being met.</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>Performance Analytics administrator: Ensures that business managers are making the best use of Performance Analytics solutions.</td>
<td>pa_admin or pa_viewer</td>
</tr>
</tbody>
</table>

Use case

This dashboard provides support managers with an overview of incoming work items and the availability of agents to handle them. Managers can monitor these daily trends to determine if adjustments should be made to the routing criteria, agent capacity values, and other settings that determine how work is pushed to agents.

Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Work Items</td>
<td>Total number of Interaction work items that were created today. The goal for this indicator is to minimize the number of Interaction work items that agents receive.</td>
</tr>
<tr>
<td>Accepted Work Items</td>
<td>Percentage of all Interaction work items that agents have accepted.</td>
</tr>
<tr>
<td>Exceeding Target Work Items</td>
<td>Percentage of all Interaction work items that have exceeded the target wait time.</td>
</tr>
<tr>
<td>Rejected Work Items</td>
<td>Percentage of all Interaction work items that agents have rejected.</td>
</tr>
<tr>
<td>Timed Out Work Items</td>
<td>Percentage of all Interaction work items that timed out.</td>
</tr>
</tbody>
</table>
### Indicator | Description
--- | ---
Weekly Trends | Number of work items in each of the following states for the past week:  
• New  
• Exceeding Target  
• Abandoned  
• Rejected  
• Timed Out

---

#### Breakdowns
To analyze data according to different categories, select a breakdown from the dashboard menu:

- Service Channel
- Queue
- Assignment Group

For more information on analyzing data with breakdowns, see Using breakdowns on dashboards.

#### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Accepted Work Items - Last Hour | Single | Number of Interaction work items that agents have accepted in the past hour.  
Score: 42 |
| Abandoned Work Items - Last Hour | Single | Number of Interaction work items that agents have abandoned in the past hour.  
Score: 42 |
### Advanced Work Assignment dashboard for tasks

Enable managers to monitor Task [task] work items so that their agents can better support customer needs.

This dashboard is available in the Advanced Work Assignment content pack. For information on activating the content pack, see Out-of-the-box Performance Analytics Solutions for Advanced Work Assignment.
Advanced Work Assignment dashboard for Tasks

End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA administrator: Configures Advanced Work Assignment to best fit the business</td>
<td>awa_admin</td>
</tr>
<tr>
<td>needs of customer service.</td>
<td></td>
</tr>
<tr>
<td>AWA manager: Identifies the areas of concern for routing and assignment of work</td>
<td>awa_manager</td>
</tr>
<tr>
<td>items across service channels.</td>
<td></td>
</tr>
</tbody>
</table>
### Use case

This dashboard provides support managers with an overview of incoming work items and the availability of agents to handle them. Managers can monitor these daily trends to determine if adjustments should be made to the routing criteria, agent capacity values, and other settings that determine how work is pushed to agents.

### Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Work Items</td>
<td>Total number of Task work items that were created today. The goal for this indicator is to minimize the amount of Task work items that agents receive.</td>
</tr>
<tr>
<td>Accepted Work Items</td>
<td>Percentage of all Task work items that agents have accepted.</td>
</tr>
<tr>
<td>Exceeding Target Work Items</td>
<td>Percentage of all Task work items that have exceeded the target wait time.</td>
</tr>
<tr>
<td>Rejected Work Items</td>
<td>Percentage of all Task work items that agents have rejected.</td>
</tr>
<tr>
<td>Timed Out Work Items</td>
<td>Percentage of all Task work items that timed out.</td>
</tr>
</tbody>
</table>

### Weekly Trends

- Number of work items in each of the following states for the past week:
  - New
  - Exceeding Target
  - Rejected
  - Timed Out

### Breakdowns

To analyze data according to different categories, select a breakdown from the dashboard menu:
- Service Channel
- Queue
- Assignment Group
For more information on analyzing data with breakdowns, see Using breakdowns on dashboards.

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Wait Time - Last Hour</td>
<td>Single</td>
<td>Average amount of time that customers have spent waiting for an agent response in the past hour.</td>
</tr>
</tbody>
</table>

Agent Workspace

Agent Workspace ™ is a configurable service desk application that provides agents with an integrated and graphically intuitive user experience.

Agent Workspace features include:

- A multi-tab interface to help agents efficiently manage multiple cases or incidents on one screen
- Real-time handling of calls and chats via Interaction Management System
- Task resolution assistance via Agent Assist
- Intuitive search capabilities enabling agents to quickly find relevant content
- Heads up display of contextual information helping agents quickly get oriented to the task at hand

By default, Agent Workspace is active for all instances.

Agent Workspace in ITSM

The following video shows a sample use of Agent Workspace in ITSM.

Navigating Agent Workspace

Use Agent Workspace to integrate Now Platform functionality that is specific to tier 1 agents into an easy-to-navigate interface.
Agent Workspace features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Lists</td>
<td>List categories that you can configure to organize lists in the list panel. You can then create filtered lists and assign them to agents or teams. Agents can create their own filtered lists under My Lists.</td>
</tr>
<tr>
<td>(2) Tabs</td>
<td>Tabs that allow agents to manage many records at once. You can enable agents to create records and complete tasks in separate tabs by configuring tables in the New Record Menu.</td>
</tr>
<tr>
<td>Forms</td>
<td>Agent Workspace form that contains a header, ribbon, and layout, including the activity stream. Configure the fields that appear on the form depending on the record type and user roles.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Contextual sidebar</td>
<td>Contextual search that you can configure to display results under Agent Assist. If you have a subscription to Predictive Intelligence, you can use this feature to produce more accurate search results.</td>
</tr>
<tr>
<td>(3) Workspace Notifications</td>
<td>Notifications that display in Agent Workspace when a record is updated or assigned to a user.</td>
</tr>
<tr>
<td>(4) Global Search</td>
<td>Search sources that you can configure to limit or expand the data that agents can access in Agent Workspace and how they appear in search results.</td>
</tr>
<tr>
<td>(5) Inbox</td>
<td>Agent Workspace inbox that you can define and configure using Advanced Work Assignments (AWA). Configuring AWA initiates routing and assigning of new work items to appropriate agents. Agents can set their availability and accept or reject work items from their Agent Workspace inbox.</td>
</tr>
<tr>
<td>(6) Module Navigation</td>
<td>A fixed tab facilitates navigation between the modules which are selectable from the left navigation bar (except CTI, if configured).</td>
</tr>
</tbody>
</table>

### Agent Workspace administrator configuration

Configure Agent Workspace for agents, so that they can access cases, incidents, or communications all from one location.

### Requirements

Your Agent Workspace configuration can vary depending on which plugins that you have enabled and who you are configuring it for. Currently, Agent Workspace is available for Customer Service Management and ITSM.

**Role required**: workspace_admin

### Using Guided Setup to configure Agent Workspace

Agent Workspace guided setup provides a sequence of tasks that help you configure Agent Workspace on your instance. To open Agent Workspace Guided Setup, navigate to Agent Workspace > Agent Workspace Guided Setup. For more information about using the guided setup interface, see Using guided setup.

### What to configure

#### Tab Settings

You can configure:

**Service Catalog**

Use the Workspace Settings to choose which Service Catalog that agents use in Agent Workspace.

**New Record Menu**

Add tables that agents can select to create records in Agent Workspace. Make sure that agents have permissions for each table in the New Record menu so that they can create a record from the menu.
Lists
You can configure the list menu by elevating your role to the workspace_list_admin role from the profile settings menu:

Create list categories
Create specific categories for lists, group lists, or records to make them easier for agents to discover.
Create filtered lists
Create filtered lists and assign them to user roles or groups.

Forms
You can configure the way forms appear for agents in Agent Workspace. You can also configure the fields that appear on the form depending on the record type and user roles.

You can configure **Lookup and Verify** to populate a list of contacts, which supports caller validation.

Form headers
Define what agents see in the form header and preview data. You can define primary field and secondary fields that contain additional information.

Ribbon settings
Add a ribbon to each record type to help agents see relevant information about the record, such as a timeline, user or customer summary, and SLAs.

Configure lookup and verify in Agent Workspace
Select a **Consumer lookup** or **Contact lookup** configuration to guide agents to find customer information.

Form layout
Configure which fields display on a form. You can hide and rearrange fields that agents do not often use to make the form more streamlined and usable.

UI Actions
Define Agent Workspace-specific UI actions. UI actions include the buttons, links, and context menu items on forms and lists. Configure UI actions to make the UI more interactive, customized, and specific for agents.

Form templates
You can find any templates that have been configured for forms in the platform to appear under the **Templates** tab in the **Contextual Sidebar**.

Search
You can define search sources for agents to query in Agent Workspace. Agents can use these keywords to search for specific records or knowledge articles in Agent Workspace.

Search Sources
Configure search sources to specify the data that agents can access in Agent Workspace.

Agent Assist
Configure contextual search for Agent Assist in Agent Workspace. Contextual search displays related articles or information in a side panel to help agents find the information they are looking for from directly within a record.

Configure similar records
Enable the contextual sidebar to show similar records to provide agents with information about similar resolutions or so they can notice trends with other similar records.

**Configure Predictive Intelligence with Agent Workspace**

Enable Predictive Intelligence Similarity Solutions in Agent Assist to improve results when searching for similar records. You can set and change an associated similarity threshold to ensure the quality of the solution results presented to the agent.

**Configure the similarity analyzer with Agent Workspace**

The Similarity Analyzer enables administrators to define patterns and trends that can assist in the resolution of a record. Utilizing Predictive Intelligence Similarity Solutions, the Similarity Analyzer can reference trends such as common resolutions, linked problems, linked changes, attached articles, major incident detection, and linked major incidents. If you enable Agent Assist Recommendations, you can provide helpful recommendations to agents when trends are detected.

**Configure Agent Assist recommendations in Agent Workspace**

You can configure Agent Assist Recommendations to display recommended actions when specified trends are found in similar incidents. After you enable and configure Predictive Intelligence and the Similarity Analyzer, you can define the recommendation messaging, display, and actions for the specified trends. Administrators can also prioritize recommendations, ensuring the best recommendation is shown when multiple trends are returned.

**Workspace Notifications**

Determine the conditions when notifications display in Agent Workspace, such as when a record updates or a record is assigned to a user.

**Advanced Work Assignment**

Configure Advanced Work Assignment (AWA) to initiate routing and assigning of new work items to appropriate agents. Agents can set their availability and accept or reject work items from their Agent Workspace inbox.

**Chat in Agent Workspace**

Configure chat for Agent Workspace so that agents can interact with customers. From a chat, agents can respond to questions, create a record, or escalate the chat to another agent.

**Agent Chat**

Enable Agent Chat to use chat functionality within Agent Workspace.

**Quick actions in Agent Workspace chat**

Set up shortcuts in Agent Workspace chat so agents can work more efficiently with their customers.

**Landing page for Agent Workspace**

Your instance should have at least one landing page, depending on the features and products that you have. All landing pages are configurable and consist of a layout with containers and widgets that appear on the page. You can use any landing page without modifications or you can clone a landing page and make updates for your installation.

**OpenFrame**

You can use OpenFrame to provide a communication frame that agents use to place and receive customer calls. Set up the CTI partner integration application for communication channels. With CTI enabled, agents can make and receive phone calls from within the workspace. The records that are created from a call can have auto-populated fields.

**Agent Workspace phone integration with OpenFrame and computer telephony integration (CTI)**
Set up a phone integration so that agents can answer calls from within the workspace.

**Components installed with Agent Workspace**

Several types of components are installed with activation of the Agent Workspace [com.agent_workspace] plugin, including tables and user roles.

*Note:* The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Workspace administrator [workspace_admin] | Provides access to the Agent Workspace application and modules to configure Agent Workspace. | • form_admin  
• chat_admin  
• template_editor  
• ui_action_admin  
• personalize_form  
• interaction_admin  
• workspace_list_admin |
| Workspace list administrator [workspace_list_admin] | Provides the ability to create list categories and to create and assign filtered lists in Agent Workspace. This is an elevated role. For more information on elevated roles, see Elevated privilege. | • agent_workspace_user |
| Workspace agent [agent_workspace_user] | Provides access to Agent Workspace. The itil and sn_esm_agent for CSM roles also contain this role. | • None |
| Workspace user [workspace_user] | Provides access to workspace_core. This role is for internal use only. | • None |

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workspace Global Search Configuration [sys_aw_global_search_config]</td>
<td>Provides the default search settings for global search in Agent Workspace</td>
</tr>
<tr>
<td>Workspace Form Header [sys_aw_form_header]</td>
<td>Defines the fields that appear in the header for a form</td>
</tr>
<tr>
<td>My Workspace List [sys_aw_my_list]</td>
<td>Enables agents to create their own filtered list in Agent Workspace</td>
</tr>
</tbody>
</table>
### Agent Workspace tab settings

Configure tab settings in Agent Workspace to help agents find and order items in catalogs, select tables to create records, and create records only from specific lists.

#### Assign a Service Catalog for Agent Workspace

Assign a specific Service Catalog with Agent Workspace to let agents find and order catalog items within the workspace.

Role required: workspace_admin

1. Navigate to **Service Catalogs > Portal Catalogs** and select **Service Catalog - Service Workspace**.
2. In the **Catalog** field, search for a catalog to associate with Agent Workspace, or click the search icon to see a list of available catalogs.
3. Click **Update**.

#### Configure the New Record Menu Items for Agent Workspace

Add tables that agents can select to create records in Agent Workspace.

Role required: workspace_admin

Agents use records to log information in the system, such as incident details, cases, or user information. Agents must have **Create** permissions for each table in the New Record menu to be able to create a record from the menu.

1. Navigate to **Agent Workspace > Settings**.
2. In the New Record Menu Items related list, click **New**.
3. In the New Record Menu Item form, select the table that you want agents to be able to create records for in the workspace.
4. In the **Order** field, enter the order that the menu item should appear from the list. The lowest number shows the menu item at the top, following in ascending order.
5. Select the **Active** option.
6. Click **Submit**.
If the order field for the Incident table is 100, and the order field for the Interaction table is 200, the graphic shows the order.

**Declarative Actions in Agent Workspace**

Add custom functionality to your Agent Workspace forms, fields, lists, and related lists without writing custom scripts or learning APIs.

**Declarative Actions**

Actions & Components appear as icons or labels in Agent Workspace. Clicking them makes them take action. Those actions can be, for example, dialing a phone number, adding a component to the Contextual Side Panel, deleting a related list, or adding a record to the database. The goal of Actions & Components is to enable your agents to take actions on one screen rather than performing the actions on multiple screens. For example, to pull up a caller's address to verify their identity, you can create an Action that pops up a caller's personal information in a modal as opposed to making the agent switch to another screen for the same information. You can create all of these actions using little or no scripting.

**Action types**

There are three Action types:

- **UI component**—Places a component in Agent Workspace, for example, an Agent Assist component in the Form Side panel.
- **Client action**—Clicking a Client Action icon dispatches an action that the browser carries out. Agent Workspace supplies a limited number of Client Actions, including dialing a phone number, opening a record, opening a form to modify record content, and opening a URL.
- Server script—Executes a script on the server to change the database, for example, to assign a record to someone, to delete a record, or to add a record.

**Action locations**

Actions can only appear in a limited number of areas in Agent Workspace. List View has only one Action, List Action and it can only appear in one place: as a button.

Record View can have the following Actions. Their names specify the locations of those Actions in Agent Workspace.

- Field decorator—Displays an icon in one or more fields in an open record. Clicking these icons can, for example, call a phone number or display additional information.
- Related List Action—Displays a button in the Related Items Menu Bar. Examples include adding or removing a related list.
- Form Side Panel Items—Displays as an icon in the Form Side Panel. Click the panel makes a component appear in the Form Side Panel. For example, you display additional Agent Assists in the Form Side Panel.
- Form Related Items—Displays as an entry in the Related Items Menu Bar. The entry works like a tab and sits, be default, between Details and Related Lists. Related Lists act like tabs that display information from tables related to the open record. Related items makes any component appear in the Form pane.

Record View Actions can only appear in the following locations.
Declarative Actions supplied with your instance

<table>
<thead>
<tr>
<th>Action</th>
<th>Action Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Assist</td>
<td>Form</td>
<td>Adds an action to the contextual side panel.</td>
</tr>
<tr>
<td>Assign to Me</td>
<td>List, Related List</td>
<td>Assigns a record to a user.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Form</td>
<td>Adds an attachment.</td>
</tr>
<tr>
<td>Call Number</td>
<td>Field</td>
<td>The only action that has a dependency (GraphQL payload).</td>
</tr>
<tr>
<td>Edit</td>
<td>List</td>
<td>Edits a record.</td>
</tr>
<tr>
<td>New</td>
<td>List</td>
<td>Creates a new record.</td>
</tr>
<tr>
<td>Open Hierarchy</td>
<td>Field</td>
<td>Opens a hierarchy.</td>
</tr>
<tr>
<td>Open Record</td>
<td>Field</td>
<td>Opens a record in a new sub-tab.</td>
</tr>
<tr>
<td>Reference Search</td>
<td>Field</td>
<td>Opens a modal to enable users to search a reference table.</td>
</tr>
</tbody>
</table>

Declarative Actions tables

<table>
<thead>
<tr>
<th>Name</th>
<th>Permissions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Declarative Action Model Definition [sys_declarative_action_model_definition]</td>
<td>Read-only for Admin</td>
<td>Defines the section in the workspace that a declarative action can exist and displays available data. Models include List, Related List, Form, and Field.</td>
</tr>
<tr>
<td>Declarative Action Model Field [sys_declarative_action_model_field]</td>
<td>Read-only for Admin</td>
<td>Represents a field in a specific model. A model can have multiple fields.</td>
</tr>
<tr>
<td>Declarative Action Definition [sys_declarative_action_definition]</td>
<td>Read-only for Admin</td>
<td>Accumulates all the declarative actions.</td>
</tr>
<tr>
<td>Declarative Action Assignment [sys_declarative_action_assignment]</td>
<td>Admin only</td>
<td>Defines where and when a declarative action runs.</td>
</tr>
<tr>
<td>Declarative Action Group [sys_declarative_action_group]</td>
<td>Admin only</td>
<td>Allows associating multiple declarative actions into a group. This action is only supported for the List model.</td>
</tr>
</tbody>
</table>

New Button List Exclusion tab functionality changes to a declarative action

Prevent users from creating a record from specific lists by using a declarative action in Agent Workspace.

In Madrid, to mask the **New** button from tables, you would add the table to the Exclusion table under Workspace Settings. In New York, the functionality to create or suppress the **New** button resides within the declarative action framework. A migration script runs on an instance upgrade to migrate these tables from the Exclusion table to a declarative action. The migration script creates declarative action assignments. To change this functionality for your table exclusion customizations, you can go to Declarative Action...
Assignments, identify the action and table affected, and confirm that the Enabled option is not selected. If you want to exclude additional tables, you can create a declarative action assignment.

**Assign a Declarative Action in Agent Workspace**

Associate a defined Declarative Action to a form, list, or field in Agent Workspace to add custom functionality to your workspace.

Role required: admin

1. Navigate to **Declarative Action > Action Assignment**.
2. Click **New**.
3. On the form, fill in the fields.

### Assign a Declarative Action form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Name</td>
<td>Unique name for your action.</td>
</tr>
<tr>
<td>Action Label</td>
<td>Action label that displays on the form when a user hovers over the field. For field decorators, the label serves as the tooltip. For list and form buttons, the label serves as the text for the button.</td>
</tr>
<tr>
<td>Action Model</td>
<td>Option that you can select for an available action from the action definition table.</td>
</tr>
<tr>
<td>Model Fields required</td>
<td>Fields that are required to display.</td>
</tr>
<tr>
<td>Description</td>
<td>Summary of the action assignment.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Text that displays when a user hovers over the field name. If a user leaves this blank, the Action Label text appears.</td>
</tr>
<tr>
<td>Form position</td>
<td>For the form action model, select either Contextual Side Bar or Related List.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that you can select with the form action model.</td>
</tr>
</tbody>
</table>

**Note:** You can add syntax `{{ }}` for an unknown value to evaluate at runtime. Example: `{{count}}`.
### ServiceNow Platform capabilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>UI view that you want to associate with the action assignment.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that the action runs in.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace that the action runs in.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that you can select. You can use this assignment if you also use Enabled.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Option that you can select. If you do not select the Enabled option, the assignment is not available and does not render.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that applies if multiple actions are selected per model.</td>
</tr>
<tr>
<td>Icon</td>
<td>Icon that is used on the field action.</td>
</tr>
</tbody>
</table>

**Note:**
- If the Active option is not available, the system falls back to the parent's table declarative action, if applicable.
- Selecting the Active option does not override this setting to make the assignment available.

4. Depending on the action assignment, you need to fill in the fields for a related list:
   - Action Attributes
   - Server Conditions
   - Server Script
   - Client Conditions

On the form, fill in the fields.

#### Action Assignment Related Lists form

<table>
<thead>
<tr>
<th>Related List</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Action Attributes | Action Payload         | Payload that you define to dispatch to an internal event when an action triggers. For example: 
{"table":"{{table}}","row":{"sys_id": 
{"value":"-1"},"parent_table":"{{parentTable}}", 
"query":"{{query}}"}} |
| Server Conditions | Record Conditions      | Condition builder that you use to add conditions that must be met before the action displays. |
|                   |                        | **Note:** You can add syntax {{}} for an unknown value to evaluate at runtime. Example: {{count}}. |
| Server Conditions | Script Condition       | Script that you add conditions that must be met before the action displays. |

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Related List

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Conditions</td>
<td>Required Roles</td>
</tr>
<tr>
<td>Server Script</td>
<td>Server Script</td>
</tr>
<tr>
<td>Client Conditions</td>
<td>Client Conditions on Fields</td>
</tr>
</tbody>
</table>

### Configure a field action as a decorator

Configure a field action in Agent Workspace to display an icon next to a reference field and then open a user record in a tab.

Role required: admin

The field action, Open Record, must exist as a Declarative Action action definition before you create a new action assignment. The icon, icon-user, must be an icon available in your instance.

1. Navigate to **Declarative Action > Action Assignment**.
2. Click **New**.
3. On the form, fill in the fields.

#### Assign the Open Record action form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Name</td>
<td>Example: user_icon_open_record</td>
</tr>
<tr>
<td>Action Label</td>
<td>Example: Open user record</td>
</tr>
<tr>
<td>Action</td>
<td>Open Record</td>
</tr>
<tr>
<td>Action Model</td>
<td>Field</td>
</tr>
<tr>
<td>Order</td>
<td>Example: 1</td>
</tr>
<tr>
<td>Table</td>
<td>Global</td>
</tr>
<tr>
<td>Icon</td>
<td>icon-user</td>
</tr>
<tr>
<td>Action Type</td>
<td>Type</td>
</tr>
<tr>
<td>Field Type</td>
<td>Reference</td>
</tr>
</tbody>
</table>

**Note**: The example descriptions can change depending on your preference. The other field descriptions must be as noted.

4. Click **Submit**.
5. Fill in the field for the Action Attributes related list:

**Open record action attribute related list**

<table>
<thead>
<tr>
<th>Related List</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Attributes</td>
<td>Action Payload</td>
<td>This script is the payload to dispatch when the open record action triggers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>{</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;referenceInfoClick&quot;: {</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;name&quot;: &quot;{{name}}&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;sys_id&quot;: &quot;{{value}}&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;referencetable&quot;: &quot;{{referenceTable}}&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;{{referenceTable}}&quot;,&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;table&quot;: &quot;{{tableName}}&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;field&quot;: &quot;{{fieldName}}&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>}</td>
</tr>
</tbody>
</table>

| Client Conditions    | Client Conditions on Fields | If you want the user icon to only appear after a user inputs value, check Requires Value. |

6. Click **Update**.

When the user icon is next to a reference field, clicking the icon opens the user record in a separate tab. The icon appears regardless of whether a user inputs a value.
Configuring Agent Workspace lists

Configure list categories and create agent-specific lists to show items by user role for Agent Workspace.

To configure lists, you need the privileged `workspace_list_admin` role. If you have the `workspace_list_admin` role, you can elevate your privileges by using the profile settings menu. For more information on privileged roles, see Elevated privilege.

The List menu in Agent Workspace has the following sections.

- Lists: Categorized set of lists that you can assign to a user by role or assignment group. If no lists are configured for a list category, the list category does not appear in the list panel.
- My Lists: Created by agents. The lists in this section are not visible to other agents.
Lists

Cases
  My Cases
  My Open
  Unassigned for my g...
  All

Customer
  Accounts
  Partners
  Contacts
  Consumers

Interactions
  My Interactions

Tasks
  My Work
  My Group's Work

SLAs
  My Work
  My Group's Work
Create list categories for Agent Workspace

Create list categories in Agent Workspace to help agents sort and find specific information that they can use for their tasks.

To create list categories, you need the privileged workspace_list_admin role. If you have the workspace_list_admin role, you can elevate your privileges by using the profile settings menu. For more information on how to get a privilege role, see Elevated privilege.

Role required: workspace_list_admin

1. Navigate to Lists > List Categories.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter a category name. For example, Open, Incidents, or Cases.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter the order that you want the category to appear in. The lowest number appears first. For example, a category with an order of 100 appears before a category with an order of 300.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this option to show the list.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the category</td>
</tr>
</tbody>
</table>

4. Click Submit.
Configure filtered lists for Agent Workspace

Create a filtered list to give agents focused list results in Agent Workspace.

To create a filtered list, you need the privileged workspace_list_admin role. If you have the workspace_list_admin role, you can elevate your privileges by using the profile settings menu. For more information about how to get a privileged role, see Elevated privilege.

Role required: workspace_list_admin

1. Navigate to Agent Workspace > Lists > List Filters.
2. Click New.
3. On the form, fill in the fields.
### List filter form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List name</td>
<td>Name for the list. Choose something that agents can easily identify. For example, Open incidents.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that you want to show records from.</td>
</tr>
<tr>
<td>Category</td>
<td>Category that a list is filed under. Select a category that you previously configured.</td>
</tr>
<tr>
<td>Columns</td>
<td>The columns to be shown in the list.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Filters that apply to the list. Use the condition builder to show or hide relevant items in the list. For example, Active is true. For more information on creating a filter, see Create a filter.</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the list appears in Agent Workspace. Select Active to ensure that it appears.</td>
</tr>
<tr>
<td>Group</td>
<td>List of users who can view the list. Add any group to limit the list access to just that group. For example, you might add Customer Service Support. You can add more than one group to the list. If you do not add a group, any user who can access Agent Workspace can access the list.</td>
</tr>
<tr>
<td>Roles</td>
<td>Specific roles that can view the list. Limit the list access by role. If you do not add a role, any user who can access Agent Workspace can access the list.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the list appears by levels of 100. The lower numbers appear first. For example, 100 appears before 200.</td>
</tr>
</tbody>
</table>

4. Click Submit.

### Configure field styles for Agent Workspace

Configure field styles to make specific fields visually distinguishable for agents.

Role required: admin

Field styles are only supported in the list view for Agent Workspace, not the form view. Only the background color field style is supported.

**Note:** For additional information on field styles, see Define field styles.

Any field that you define for a field in a parent table also appears in the child table. For example, if you apply a field style to the Priority field in the task table, the Priority field in the Incident table also shows the field style.

1. Navigate to System UI > Field Styles, and locate the field to apply a style to.

   **Note:** You can make changes to field styles through the platform, not the Agent Workspace UI.

2. Click New, or click the style that you want to modify.

3. On the form, fill in the fields.
### Style form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table that contains the field.</td>
</tr>
</tbody>
</table>

**Note:** The list shows only tables and database views that meet the scope protections for field styles.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field name</td>
<td>Field to which the style applies.</td>
</tr>
<tr>
<td>Value</td>
<td>Value or script-based-condition required to apply the style.</td>
</tr>
</tbody>
</table>

**Note:** The value only affects list field styles. To apply field styles on both lists and forms, leave this field blank.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>CSS style to apply. Only the background color field style is supported for workspace.</td>
</tr>
</tbody>
</table>

For example, you can make the background of the **Incident Category** fields red in the record lists, by entering the following code:

```css
background-color:red;
```

4. Click **Submit** or **Update**.

---

**Field styles**

---

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Configuring Agent Workspace forms

Configure the way that forms appear for agents in Agent Workspace so that they can easily find the information they need to complete their tasks. You can also configure the fields that appear on the form depending on the record type and user role.

You can configure templates with pre-populated fields and UI actions to make the workspace more interactive. You can also configure **Lookup and Verify** to help agents look up and verify contact or consumer information.

The fields in the Agent Workspace form are limited to the ones that agents use the most. For a list of available fields, see [Agent Workspace supported field types](#).
Form navigation

Form elements

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Form tab</td>
<td>Tab that identifies the open record. Agents can have an unlimited number of</td>
</tr>
<tr>
<td></td>
<td>tabs open and can work between tabs without leaving their working session.</td>
</tr>
</tbody>
</table>
## Feature Description

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(2) Sub tabs</td>
<td>Tabs that enable agents to open related information from a form in a sub tab. Any related information that agents open from a form opens in a subtab. That way, agents do not lose any context from where they started.</td>
</tr>
<tr>
<td>(3) Reference icon</td>
<td>Reference icon that opens a subtab where the agent can see more information about the record. For example, a reference icon on a caller gives user information on that person.</td>
</tr>
<tr>
<td>(4) Activity stream</td>
<td>Stream that enables agents to view all the activity for a record. Agents use the activity stream filter to focus on more specific information in the stream.</td>
</tr>
<tr>
<td>(5) Related lists</td>
<td>Lists that agents can reference to give accessible related context. For example, Child Incidents show related incidents to the record.</td>
</tr>
<tr>
<td>(6) Contextual sidebar</td>
<td>Displays icons corresponding with these options:</td>
</tr>
<tr>
<td></td>
<td>• Agent Assist - displays/hides the Agent Assist panel from which you can attach articles, order catalog items, or find community discussions.</td>
</tr>
<tr>
<td></td>
<td>• Attachments - displays/hides the Attachments panel from which you can add an attachment to the record. Attachments are automatically scanned for viruses when added.</td>
</tr>
<tr>
<td></td>
<td>• Templates - displays/hides the Templates panel from which you can apply a template. Templates created for platform records also apply to workspace records. For more information on creating a template, see form templates. Templates in workspace follow any ACL rules that have been configured.</td>
</tr>
<tr>
<td>(7) UI actions</td>
<td>Actions that agents can perform on the form. UI actions in workspace can either be buttons or menu items.</td>
</tr>
<tr>
<td>(8) Record tags</td>
<td>You can add tags to records in Agent Workspace. Tag visibility can be set to all users, visible only to specific groups or users, or visible to a single user.</td>
</tr>
<tr>
<td>(9) Highlighted Values</td>
<td>You can add highlighted values to the secondary values in the form header in Agent Workspace.</td>
</tr>
</tbody>
</table>

### Configure the form header for Agent Workspace

Configure the form header and subheaders in Agent Workspace so that agents can quickly see information about each record.

Role required: workspace_admin

Form headers are made up of one primary header and several secondary headers, or subheaders.

1. Navigate to Agent Workspace > Forms > Form Headers.
2. Click New.
3. Select a table from the list.
   - **Note:** Configuration tables are not included as an option for form headers in Agent Workspace.
4. From the Primary field list, select the field that you want as the form header.
   - Choose a field that is descriptive and unique. For example, you could choose short_description.
5. Right-click the form header and select Save.
6. To add secondary fields to the form subheader, select the fields that add important details to the form, such as priority, state, and category.

**Note:** You can select as many secondary fields for the header as you want; however, only the first five non-empty fields show in the header.

7. Click Submit.

Forms can inherit the header configuration from the parent tables. For example, if the Incident [incident] table does not have a table configuration, any incident records inherit the configuration from the Task [task] table.

### Configure Agent Workspace ribbon settings

Configure components that appear on a form ribbon in Agent Workspace. The form ribbon helps agents quickly scan relevant information about the record, such as a timeline, a user or customer summary, and SLAs.

Role required: workspace_admin

1. Navigate to Agent Workspace > Forms > Ribbon Settings.
2. Click New.
3. In the Name field, enter a name for the ribbon setting.
4. In the Ribbon Component field, select a ribbon component.
   
   Component options vary depending on which plugins are enabled for your instance.

   Depending on the component that you select, additional information appears on the form.
5. From the Table list, select the table that you want the ribbon component to appear in on the workspace form.
6. From the Width list, select a width for the component.
   
   The width is based on the 12-column flexbox layout.
7. In the Order field, enter a number between 100-199 to determine the order that the component appears.
   
   The smallest number means that the component appears first in the ribbon.

---

For the timeline configurations, you also must configure the Resolution Shaper for a selected table. See Configure ribbon component attributes.
Configure lookup and verify in Agent Workspace

Configure a Consumer lookup or Contact lookup so that agents can easily identify the consumer information or contact information.

Role required: workspace_admin, admin

Two lookup and verify configurations are provided: one for contacts and one for consumers. You can configure settings in these configurations to control the type-ahead search and the information that is displayed in the search results list and the verification card.

1. Navigate to Agent Workspace > Lookup and Verify > Configuration.
2. Select a configuration from the list.
3. Select the Active option.

   A configuration must be active for the related UI action to appear on the interaction record.
4. Optional: In the Minimum characters to start typeahead search field, enter the minimum number of characters that you want for your search.
5. In the Max result count list, set the maximum number of search results up to a maximum of 10.
6. Configure the Search results tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary field</td>
<td>Select the name of the field that you want a contact or consumer to see in the search results list.</td>
</tr>
<tr>
<td>Secondary fields</td>
<td>Unlock to access the Secondary fields and move a secondary field from the Available list to the Selected list. Lock when done.</td>
</tr>
</tbody>
</table>

7. Configure the Verification card tab.

   Unlock to access the Display fields and move a field from the Available list to the Selected list. Lock when done.
8. Click Update to save the configuration.

Configure highlighted values in Agent Workspace

Add highlighted values to the secondary values in the form header in Agent Workspace.

Role required: admin

1. Navigate to Agent Workspace > Highlighted Values.
2. Click New.
3. On the form, fill in the fields.

   **Highlighted Value form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table that you want the highlighted value to display.</td>
</tr>
<tr>
<td>Field</td>
<td>Field that you want the highlighted value to display.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains the record.</td>
</tr>
</tbody>
</table>

4. Click Update.
5. Select the record, go to the Highlighted Value Conditions related list, and click New.
6. On the form, fill in the fields.

### Highlighted Value Condition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditions</td>
<td>Condition builder where you can set the conditions for your highlighted value to display.</td>
</tr>
<tr>
<td>Status</td>
<td>Status to display for your highlighted value:</td>
</tr>
<tr>
<td></td>
<td>• Critical</td>
</tr>
<tr>
<td></td>
<td>• High</td>
</tr>
<tr>
<td></td>
<td>• Info</td>
</tr>
<tr>
<td></td>
<td>• Low</td>
</tr>
<tr>
<td></td>
<td>• Moderate</td>
</tr>
<tr>
<td></td>
<td>• Positive</td>
</tr>
<tr>
<td></td>
<td>• Warning</td>
</tr>
<tr>
<td></td>
<td>• None</td>
</tr>
<tr>
<td>Show icon</td>
<td>Option that you can select to display an icon with the status.</td>
</tr>
<tr>
<td>Value Override</td>
<td>Text that you can specify to render in the highlighted value. You can reference a value using <code>{{value}}</code>.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains the record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the highlighted values are evaluated.</td>
</tr>
</tbody>
</table>

### Configure a highlighted value

Configure a highlighted value for the **Priority** field in problem records when the priority is **1 - Critical**. Select the Incident table and the **Priority** field when creating this highlighted value.

In the Highlighted Value Conditions, set the conditions to be **Priority** is **1 - Critical** and **Status** **Critical** and check **Show icon**.

The highlighted value renders for this configuration:

![Employee payroll application server is down.](image)

### Record tagging in Agent Workspace

Add tags to records in Agent Workspace. You can set the tag visibility to all users, visible only to specific groups or users, or visible to a single user.
Record tags

Tags are text labels that you associate to records to organize records. On any given record, click the Record Tag icon to add a tag or tags to your record.

Record tagging viewing levels

Three viewing levels of tagging are available:

**Me**

This setting is for a private tag which is visible only to the owner of the record.

**Groups and Users**

This setting is for a shared tag which is visible to specific groups or users.

**Everyone**

This setting is for a global tag which is visible to everyone. This sharing level is only available to an admin or tags_admin role.
Disable record tagging for your instance

You can disable tags for an entire instance. Create the following system property and parameters:

<table>
<thead>
<tr>
<th>Disable record tagging</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Property</td>
</tr>
<tr>
<td>glide.ui.show.form_tags_bar</td>
</tr>
</tbody>
</table>

Configure the form layout for Agent Workspace

Configure the form layout for the workspace form view so agents can create or edit a form.

Only one form view is available per table in Agent Workspace. The form view that agents see vary depending on the views that you configure for each agent role. Agents only see the form that is specific to them.

- **Note:** Not all field types are supported in Agent Workspace.
- **Note:** Record types without a workspace view appear as read-only in Agent Workspace.

Role required: personalize_form

1. Navigate to a form that you want to configure for Agent Workspace.
For example, you might want to configure a case [sn_customerservice_case] or an incident [incident].

2. Click the context menu icon ( ) and select **Configure > Form Layout**.

3. From the view name list, select the workspace that you want to configure a form view. For example, you might select **Workspace_itil**.
4. Select the fields and the order in which you want them to appear.
   Available items that appear in green followed by a plus (+) sign represent related tables. To access the fields on these tables, use dot-walking.

5. Click Save.
Do not add the same field to more than one section of a form unless the field displays read-only data. Having two or more instances of an editable field can cause data loss and prevent the proper functioning of UI and data policies.

Add new fields to the form. For more information on how to add a customized field, see #unique_84.

**Agent Workspace supported field types**
Check which field types are supported for Agent Workspace so that you can properly configure the form layout.

<table>
<thead>
<tr>
<th>Field type</th>
<th>Description</th>
<th>Supported properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice</td>
<td>List of configurable choices.</td>
<td></td>
</tr>
</tbody>
</table>
| Currency         | Decimal field with four digits after the decimal point. When displayed on a form, a currency field also includes an additional choice list for selecting the currency type. If there is no default value for the field, empty currency fields use the reference currency. Adding a value causes the field to use the session currency of the active user. See #unique_85 for how to use two fraction digits. | • glide.currency_price.use_all_fraction_digits  
• glide.system.locale  
• glide.i18n.single_currency  
• glide.i18n.single_currency.code  
• glide.currency_price.use_all_fraction_digits |
<p>| Date             | Day, which can be selected with a calendar widget. | glide.ui.date_picker.first_day_of_week                                                |
| Date/Time        | Day and time of day, which can be selected with a calendar widget. | glide.ui.date_picker.first_day_of_week                                                |
| Decimal          | Number with up to two digits after the decimal points (for example, 12.34). | glide.system.locale                                                                 |
| Document ID      | Reference to any record on any table.            |                                                                                      |
| Duration         | Length of time. Stored in the database as an integer number of milliseconds, but appears in days, hours, minutes, and seconds. |                                                                                      |
| Email            | Field for an email address. Entries must contain @ and a top-level domain, such as .com or .edu. |                                                                                      |
| Floating point number | Number with up to seven digits after the decimal point. |                                                                                      |</p>
<table>
<thead>
<tr>
<th>Field type</th>
<th>Description</th>
<th>Supported properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML</td>
<td>String field with a built-in HTML editor.</td>
<td>• glide.sys.language&lt;br&gt;• glide.ui.html.editor.languages&lt;br&gt;• glide.ui.html.editor.v4.toolbar.valid.buttons&lt;br&gt;• glide.ui.html.editor.v4.font.collection&lt;br&gt;• glide.ui.html.editor.remove_host&lt;br&gt;• glide.ui.html.editor.relative_urls&lt;br&gt;• glide.ui.html.editor.convert_urls&lt;br&gt;• glide.ui.html.editor.extended_valid_elements</td>
</tr>
<tr>
<td>Integer</td>
<td>Number with zero decimal points.</td>
<td>glide.system.locale</td>
</tr>
<tr>
<td>Journal Input</td>
<td>Field that accepts text entries but does not display previous entries.</td>
<td>glide.ui.textarea.character_counter</td>
</tr>
<tr>
<td>List</td>
<td>Reference field that accepts multiple references rather than just one.</td>
<td>• glide.ui.max_ref_dropdown&lt;br&gt;• glide.ui.reference.disable_displayvalue_warning</td>
</tr>
<tr>
<td>Password (1-way encrypted)</td>
<td>Text field that stores passwords with one-way encryption. One-way encryption stores the password as a secure hash value that cannot be decrypted.</td>
<td></td>
</tr>
<tr>
<td>Phone number</td>
<td>String field that provides E164-compliant formatting and validation for telephone numbers.</td>
<td>glide.ui.format_phone</td>
</tr>
<tr>
<td>Reference</td>
<td>Query that displays records from another table.</td>
<td>• glide.ui.max_ref_dropdown&lt;br&gt;• glide.ui.reference.readonly.clickthrough</td>
</tr>
<tr>
<td>Field type</td>
<td>Description</td>
<td>Supported properties</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>String</td>
<td>For 255 characters or less, the string field is a single-line text field. Anything 256 characters or over appears as a multi-line text box. Note: The database may translate the value that you provide in the Max length field to the closest matching database field type. For example, a max string length of 80 maps to the nearest database field type of VARCHAR(100). For Oracle instances, users are not able to increase the max length of a string field to a value greater than 4000 through the application UI. Changes greater than 4000 require the CLOB data type in Oracle. If you require a field to be larger than 4000 characters, log an incident to request the change.</td>
<td>glide.ui.textarea.character_counter</td>
</tr>
<tr>
<td>Suggestion</td>
<td>String field that provides suggested values but accepts free-form text. Available when you add a field by configuring a form or list. Otherwise, you must modify the dictionary entry of an existing string or journal field.</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>Specific time. Stored in the database as a date/time field. Only the time part of this field is used. Note: This field always stores the date as 1970-01-01, which does not fall within the dates for Daylight Savings Time (DST). As a result, the time is not automatically adjusted for DST. If a custom feature uses time as a start time, it is the responsibility of the feature to adjust for DST, if necessary.</td>
<td></td>
</tr>
<tr>
<td>Translated HTML</td>
<td>HTML field that displays different translations that are based on the user's language.</td>
<td></td>
</tr>
<tr>
<td>Field type</td>
<td>Description</td>
<td>Supported properties</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>True/False</td>
<td>Boolean field that appears as a one-digit integer, typically 1 (true) or 0 (false).</td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td>String field that is a clickable URL field when locked.</td>
<td></td>
</tr>
</tbody>
</table>

**Note**: In the mobile UI, this field appears as a multi-line text field. The field saves as a single line, with the line breaks removed.

---

**Configure Workspace View Rules by role for Agent Workspace**

Administrators can use Workspace View Rules to control which form view renders for their users by role.

Role required: admin

1. Navigate to **Agent Workspace > Forms > Workspace View Rules**.
2. Click **New**.
3. Fill out the following fields:

<table>
<thead>
<tr>
<th>Workspace View Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Table</td>
</tr>
<tr>
<td>View</td>
</tr>
<tr>
<td>Application</td>
</tr>
<tr>
<td>Workspace</td>
</tr>
<tr>
<td>Active</td>
</tr>
</tbody>
</table>
4. Under Conditions, select the roles that the rule applies.

Use the role selection picker:

<table>
<thead>
<tr>
<th>Available</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>action_designer</td>
<td></td>
</tr>
<tr>
<td>activity_admin</td>
<td></td>
</tr>
<tr>
<td>activity_creator</td>
<td></td>
</tr>
<tr>
<td>acts_sub_admin</td>
<td></td>
</tr>
<tr>
<td>acts_sub_user</td>
<td></td>
</tr>
<tr>
<td>admin</td>
<td></td>
</tr>
<tr>
<td>agent_admin</td>
<td></td>
</tr>
<tr>
<td>agent_schedule_admin</td>
<td></td>
</tr>
<tr>
<td>agent_schedule_manager</td>
<td></td>
</tr>
</tbody>
</table>

5. Click **Submit**.

Users with the role selected view the form view configured for this rule.

If there are multiple Workspace View Rules in place, the rule with the lower execution order applies. If the execution order is the same for multiple rules, the first rule created applies.

**Configure a form view by role for Agent Workspace**

Set different form view for agents by configuring a form that is based on their role.

Agents can be specific to CSM (for cases) or ITSM (for incidents), or an agent can have combined responsibilities. A workspace view is configured for each type of agent. Views use the following role-based hierarchy to determine which form the agent sees in Agent Workspace.

Any view/role combination that results in the **Default** form view is read-only.

<table>
<thead>
<tr>
<th>Role</th>
<th>Form view</th>
</tr>
</thead>
</table>
| itil     | 1. workspace_itil  
           2. workspace  
           3. default  |
ServiceNow, DocVersion, Now Platform capabilities

<table>
<thead>
<tr>
<th>Role</th>
<th>Form view</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_esm_agent</td>
<td>1. workspace_csm</td>
</tr>
<tr>
<td></td>
<td>2. workspace</td>
</tr>
<tr>
<td></td>
<td>3. default</td>
</tr>
<tr>
<td>both itil and sn_esm_agent</td>
<td>1. workspace_csm</td>
</tr>
<tr>
<td></td>
<td>2. workspace_itil</td>
</tr>
<tr>
<td></td>
<td>3. workspace</td>
</tr>
<tr>
<td></td>
<td>4. default</td>
</tr>
<tr>
<td>admin or workspace_admin</td>
<td>1. workspace</td>
</tr>
<tr>
<td></td>
<td>2. default</td>
</tr>
<tr>
<td>other</td>
<td>If the agent does not have either role, but does have another role that still provides access to the forms:</td>
</tr>
<tr>
<td></td>
<td>1. Workspace</td>
</tr>
<tr>
<td></td>
<td>2. Default</td>
</tr>
</tbody>
</table>

Configure Workspace View Rules by field values for Agent Workspace

Administrators can use Workspace View Rules to control which form view renders for their users. Set conditions on field values.

Role required: admin

1. Navigate to Agent Workspace > Forms > Workspace View Rules.
2. Click New.
3. Fill out the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the view rule.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table to apply the rule.</td>
</tr>
<tr>
<td>View</td>
<td>Select the form view to render for the conditions set.</td>
</tr>
<tr>
<td>Application</td>
<td>Select the application scope that contains this record.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Select a workspace available.</td>
</tr>
<tr>
<td>Active</td>
<td>Check to make this rule active.</td>
</tr>
</tbody>
</table>
4. Under Conditions, and configure filter conditions. For example, you can set conditions on the watch list field.

![Conditions](image)

5. Click **Submit**.

Records that meet the conditions set render in the form view.

**Create custom UI actions for Agent Workspace**

Create UI actions to customize Agent Workspace for your organization. With UI actions, you can create custom buttons or menu items and you can also limit agent access to certain forms by user role.

**Role required: workspace_admin**

Agent Workspace only supports UI actions for menu items or form buttons. Buttons appear in the top right of the form and menu items appear in the workspace menu in the form.

1. Navigate to **System Definition > UI Actions**.
2. Open the UI action that you want to enable for the workspace or create a UI action. The following fields work in both workspace and the platform:
   - Name
   - Table
   - Order
   - Action name
   - Active
   - Show insert
   - Show update
   - Client
   - Hint
   - Condition
   - Script (server scripts only)

   For more information on each field on the UI actions form, see **UI actions**.

3. To create a client script for the UI action, select the **Client** option.

   The system does not check the workspace client script field unless this check box is selected.

4. To create a server script for the UI action, in the **Script** field, enter the server script.

   For example, if you want to include the caller name and the short description in an incident that is created from an interaction record, you could use the following script:

   ```javascript
   if(current.update()){
   var inc = new GlideRecord("incident");
   inc.newRecord();
   inc.caller_id = current.opened_for;
   inc.short_description = current.short_description;
   action.openGlideRecord(inc);
   }
   ```
The system ignores any client scripts that are included in this field. You can only use the workspace client script field for client scripts.

5. In the **Workspace** tab, select the **Workspace Form Button** option or the **Workspace Form Menu** option.

The **Workspace Client Script** field appears.

6. Optional: In the **Workspace Client Script** field, create a workspace-specific client script.

Workspace has similar client scripting limitations as Service Portal. For example, to open a form by clicking it, you could add the following client script:

```javascript
function onClick(g_form) {
}
```

For more information on available client scripts for workspace, see [Supported client script types and APIs](#).

7. In the **Requires role** tab of the workspace section, add any roles that you want to limit access to the UI action to.

8. Click **Submit** or **Update**.

Using the condition builder to customize UI actions for Agent Workspace

Configure UI actions by adding conditions to a UI Action form.

**Using the UI action condition builder**

The following condition is configured for the **Close Incident** button:
For this action to appear on a form, these conditions must evaluate to true:

- `current.incident_state` must equal 6: The incident must already be in a Resolved state.
- `gs.hasRole("itil_admin")`: The current user must have the itil_admin role.

OR this condition must evaluate to true:

- `gs.getUserID() == current.caller_id`: The current user is the user who requested the change.

**Note:**

- The current object is not available for conditions on a list context menu or list choice. The List context menu option or List Choice option is selected. Any use of `current` on these actions is ignored.
- You can reference the parent record for the UI action conditions on a related list button. For example, to disable the New and Edit buttons on the Affected CIs related list for
Configure templates for Agent Workspace

Configure templates for Agent Workspace. Templates display content for defined fields on a specified table that are relevant to your agent.

Any templates that you create for a form in the platform also work in Agent Workspace.

Role required: admin

1. Navigate to System Definition > Templates.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of this template.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that this template applies to. Select Global to make the template available for use with all tables.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The table list shows only the tables and database views that are in the same scope as the template.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for making the template available for use. A template must be active to be used.</td>
</tr>
<tr>
<td>User</td>
<td>User who can configure and apply the template. If you define a user, no other users can see the template unless you select the Global option.</td>
</tr>
<tr>
<td>Group</td>
<td>Group whose members can configure and apply the template. If you define a group, no other groups can see the template unless you select the Global option.</td>
</tr>
<tr>
<td>Global</td>
<td>Option for allowing any user who can access the templates to view and apply this template.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description of the template.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Template</td>
<td>Content that automatically populates records that are based on this template. Select a field from the specified table in the left column and then enter the data to automatically populate in the right column.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Even though you can select dot-walked fields in the template, they do not apply to fields that are on the form.</td>
</tr>
<tr>
<td>Link element</td>
<td>Template that links a child table with the template for the parent table. In the template for the child table, set the value to the field that references the parent table. After you set the value, the child template is explicitly linked to the parent table.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field does not appear by default. Configure the template form to add the field.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

You can also create a template by saving a form. For more information, see #unique_90.

**Add special handling notes to records in Agent Workspace**

Add special handling notes to highlight important information on a record for agents to quickly see and act upon.

**Viewing a special handling note**

Special handling notes appear in a pop-up window when the agent opens the record in Agent Workspace.
Priorities for special handling notes

The Special Handling Notes pop-up window displays up to three notes. Notes are also available in the Special Handling Notes related list. Agents can see a priority, short description, and message for each note. Notes are ordered by priority and use different styles that are based on the priority and type:

- Priority 1 — red
- Priority 2 — yellow
- Priority 3 — green
- Priority 4 — blue

Agent actions for special handling notes

Agents can:

- Dismiss individual notes. When all notes are dismissed, the pop-up window closes.
- Close the window. After the pop-up window closes, the agent cannot reopen it during the current session.
Roles

In the Special Handling Notes module on the platform:

- Users with the sn_shn.admin role can configure special handling notes and specify properties.
- Users with the sn_shn.admin or sn_customerservice_manager roles can create special handling notes.

Journal fields in Agent Workspace

Enter information on a form using Agent Workspace journal fields. The information in these fields helps you collaborate and communicate about the record. In New York, only journal_input fields are supported. Journal_input fields are multi-line text boxes which add comments into the activity field. By default, the Additional comments and Work notes journal fields are available.

Attachment management

When you download a file, the system automatically scans it for viruses. If the file has a virus, the message "File unavailable" appears under the file name in the Activity Stream and an error message displays at the top of the screen. You will not able to view or download the file.
After a user attaches a file, you can preview the file before you download it. Click the file's icon in the Activity stream or the Attachments panel to preview the attachment.
Click the download icon (△) to save file locally.
Rich text editing

Rich text editing is available if TinyMCE is enabled by setting the glide.ui.journal.use_html system property to true. If TinyMCE is enabled, you can customize field text in journal fields using the buttons at the top of the field.

Activity

Respond via Additional comments (Customer visible) ▼

<table>
<thead>
<tr>
<th>B</th>
<th>I</th>
<th>U</th>
<th>Verdana -</th>
<th>☕</th>
<th>☕</th>
<th>☕</th>
<th>☕</th>
<th>☕</th>
<th>☕</th>
<th>☕</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type comment or attach solution</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If TinyMCE is enabled, you can paste an image directly into a journal field and enter inline text.

Activity

Respond via Additional comments (Customer visible) ▼

<table>
<thead>
<tr>
<th>B</th>
<th>I</th>
<th>U</th>
<th>Verdana -</th>
<th>☕</th>
<th>☕</th>
<th>☕</th>
<th>☕</th>
<th>☕</th>
<th>☕</th>
<th>☕</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is an example of an image pasted directly into the journal field:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Configuring search options for Agent Workspace

Configure search sources, Agent Assist settings, global search settings, similar records, and Predictive Intelligence as search options for agents.

You can configure five distinct search options within Agent Workspace. These configuration options include:

Prioritizing search sources

You can prioritize the order that search sources report search results within Agent Assist. You can also use a condition builder to add conditions to your search results.
Distinguishing search results for agents by view
You can distinguish a UI view for Agent Workspace that is separate from a UI view for the Now Platform. You can use conditions and custom scripts to restrict results that are returned for Agent Assist searches.

Global search settings
You can change the default settings for Agent Workspace global search regarding the number of search results that display for agents.

Showing similar records
You can expose similar records for agents to note trends and to suggest information by viewing similar resolutions.

Enabling Predictive Intelligence
You can enable machine learning for agents to apply predictive capabilities regarding trending issues.

Configure a search source for Agent Workspace
Configure a search source in Agent Workspace to define where search data is retrieved from.

Role required: workspace_admin

1. Navigate to Agent Workspace > Search Configuration.
2. In Application Search Sources, click New or open an existing record to edit a record.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the search source. This name appears as a search category in the workspace search.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that the search pulls information from. For example, the search might pull in information from Knowledge [kb_knowledge] or Users [sys_user].</td>
</tr>
<tr>
<td>Conditions</td>
<td>Search filter that limits the records that are returned in the search. For example, you could limit the search to return only the published and valid knowledge articles.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope that this search source should run in.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that you select to enable the Search Source for your workspace.</td>
</tr>
</tbody>
</table>

4. Click Save or Update.

Configure contextual search for Agent Assist in Agent Workspace
Configure contextual search for Agent Assist so agents can access pertinent information in the Agent Assist side panel to respond to user requests.

Contextual search helps users deflect or quickly resolve their issues without involving the service desk operators. Contextual search displays search results including Knowledge, Service Catalog, Communities, and Additional resources on forms when users enter text in a field. Agent Assist uses a contextual search in a similar way as the Now Platform. For additional information on using and configuring contextual search, see Contextual search.
Configure contextual search form settings for Agent Workspace
Define which search results for Agent Assist appear for a particular form, the information the results contain, and what the agent can do with the results.

Role required: admin

1. Navigate to **Contextual Search > Table Configuration**.
2. Click a record and then click **New**.
3. On the form, fill in the fields.

### Table Configurations form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Name of the table that is associated with the form. An example is Incident [incident] or case [sn_customerservice_case].</td>
</tr>
<tr>
<td>Note: The list shows only tables and database views that are in the same scope as the contextual search.</td>
<td></td>
</tr>
<tr>
<td>UI type</td>
<td>UI that the configuration applies to. Select <strong>Workspace</strong>.</td>
</tr>
<tr>
<td>Search context</td>
<td>Name of the search context that this table configuration applies to.</td>
</tr>
<tr>
<td>Results header text</td>
<td>Text that displays above the search results.</td>
</tr>
<tr>
<td>Enable related search box</td>
<td>Option that is automatically enabled for Agent Workspace</td>
</tr>
<tr>
<td>Enable source selector</td>
<td>Option that you can enable to select the search source.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that you select to activate this configuration.</td>
</tr>
<tr>
<td>Limit</td>
<td>Maximum number of search results returned.</td>
</tr>
<tr>
<td>Results per page</td>
<td>Number of results to appear per page.</td>
</tr>
<tr>
<td>Allow expand/collapse</td>
<td>Option that you can enable to expand or collapse for search results.</td>
</tr>
<tr>
<td>Enable preview buttons</td>
<td>Preview buttons that you can enable for search results.</td>
</tr>
<tr>
<td>When to display</td>
<td>Conditions under which this search is enabled. For example, set [Active] [is] [true] to only enable the search on active knowledge articles.</td>
</tr>
<tr>
<td>Enable search as</td>
<td>Option that you select to define the results to show for a different user. Click the <strong>Search as</strong> tab for the check box. For more information, see #unique_96.</td>
</tr>
</tbody>
</table>

4. In the Search fields related list, select the field that the system uses to query contextual search.
5. Click **Update** to save the configuration.
6. In the Search Action Configurations related list, add or remove the following UI actions that an agent can perform on each contextual search result:
   • Helpful
   • Order
   • Attach
   • Flag article
   • View full article

**Define search UI action labels for Agent Assist**

Define the search UI action labels for Agent Assist so that agents know what to do with the search results.

Search results for the default field appear automatically in the Agent Assist section when an agent opens a record. Search results in other associated fields only appear when an agent types content in those fields.

1. Navigate to **Contextual Search > Table Configuration** and open a record.
2. In the Search UI Action Configurations related list, edit any of the following label fields in the list.

<table>
<thead>
<tr>
<th>UI action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action label</td>
<td>Label to indicate what to do with the search result. For example, use <strong>Attach</strong> to attach a knowledge article search result to the activity stream.</td>
</tr>
<tr>
<td>Action undo label</td>
<td>Label that appears to undo an action. For example, <strong>Unattach</strong> appears as an option after you attach an article to an activity stream.</td>
</tr>
<tr>
<td>Badge label</td>
<td>Label that appears on the search result after you have completed an action. For example, after you attach an article to the activity stream, <strong>Attached</strong> appears as a badge on the knowledge article search result.</td>
</tr>
</tbody>
</table>

**Associating a knowledge article in Agent Workspace with Agent Assist**

Determine whether to deliver a knowledge article to the activity stream as a full article attachment or as a link to the article.

Role required: admin

1. Navigate to **Contextual Search > Table Configuration**.
2. Open an existing table configuration. If you are configuring a knowledge article specifically for workspace, make sure that you open a table configuration with the UI type **Workspace**.
3. In the Search Action Configurations related list, open a UI action with a search resource of **KnowledgeSearchResource**.
   The **KnowledgeSearchResource** is not configurable.
4. In the **Attachment type** field, you can choose to embed a link or embed an article:
   • **Embed link to article**: Includes a link to the article in the activity stream for the record.
   • **Embed article**: Attaches the entire article in the activity stream for the record.
5. Click **Update** to save the configuration.
Configure global search settings for Agent Workspace

Change the default settings on the Workspace Global Search Configuration page to amend the number of search results that display for agents.

Role required: workspace_admin

1. Navigate to Agent Workspace > Settings.
2. Click the Global Search preview icon and then click Open Record.
3. In the Name field, change the name from the default name.
4. On the form, fill in the fields.

Global Search Configuration Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recent Items count</td>
<td>Number of recently selected search results that appear in the global search field. The default number is 5.</td>
</tr>
<tr>
<td>Recent terms count</td>
<td>Number of recently searched terms that appear in the global search field. The default number is 5.</td>
</tr>
<tr>
<td>Recent TTL (days)</td>
<td>Time To Live, which is the length of time in days that recently searched terms and recently selected search results remain in the search history. The default number is 30.</td>
</tr>
<tr>
<td>Tab drilldown items per page</td>
<td>Number of search results that appear at one time when you view search results for a specific search category. The default number is 25.</td>
</tr>
<tr>
<td>Tab overview items per section</td>
<td>Number of items that appear in the search results by section. The default number is 10.</td>
</tr>
</tbody>
</table>

5. Click Update.

Note:
If any access control lists (ACLs) are configured to prevent users from accessing certain information, the search results show a message to the agent about security constraints. For more information on limiting access using ACL rules, see #unique_100.

Configure similar records for the contextual sidebar in Agent Workspace

Configure the contextual sidebar to show similar records to agents. With this information, agents can see similar resolutions or notice trends with other similar records.

By integrating Predictive Intelligence, the Agent Workspace contextual sidebar enables agents to see similar incidents and problems using a combination of contextual search configurations and the Machine Learning feature. Predictive Intelligence with Agent Workspace is on by default for any customer who is upgrading to the Madrid release.

Note:
The Machine Learning feature in the contextual sidebar is only available to customers who have a Machine Learning subscription. Additional features, such as Major Incident detection and similar incidents, are also only available through subscription.

Configure additional resources for similarity in the contextual sidebar in Agent Workspace
Configure similarity thresholds for records to display in the contextual sidebar.
Role required: admin
1. Navigate to Contextual Search > Additional Resources.
2. Choose a pre-defined search resource from Search Resources and edit the Title field and Additional fields.

Configure additional resource fields in Agent Workspace
Configure the layout of similar record fields in the contextual sidebar so agents see relevant information in a predictable order.
Role required: Admin
2. Open an Incident, Problem, or Case and edit the Title field and Additional fields.

Agent Assist recommendations in Agent Workspace
You can use Agent Assist recommendations in Agent Workspace to show agents actions taken on similar incidents or cases.

Agents typically work incidents or cases that are similar to many other incidents or cases across their team. Agent Assist recommendations derive from the common actions made by other agents and use trending data to make helpful resolutions. The Agent Assist recommendations rely on configuring a Predictive Intelligence solution and configuring a similarity analyzer for detecting trends.

Once the configuration of a similarity solution, similar trend, and recommendation exist, agents using Agent Workspace can receive recommendations based on work:

- Problem resolutions
- Change requests
- Attachments of relevant articles
- Major incident resolutions

Configure Predictive Intelligence with Agent Workspace
Enable Predictive Intelligence similarity solutions in Agent Assist to improve results when agents search for similar records. You can set and change an associated similarity threshold to ensure the quality of the solution results that are shown to the agent.

See Implement the initial setup and configuration for Predictive Intelligence on your instance.
Role required: admin
1. Navigate to Predictive Intelligence > Classifications > Solution Definitions.
   You can also use the Agent Workspace Guided Setup Search > Predictive Intelligence (Machine Learning Solutions) > Configure
2. Click New to create a new solution definition or open an existing solution definition that returns similar incidents.
3. Click Save or Submit & Train.

Configure the similarity analyzer with Agent Workspace
Use the similarity analyzer to define patterns and trends that can help your users resolve a record.
Role required: admin

Use Predictive Intelligence similarity solutions for the similarity analyzer to reference trends. Trends include common resolutions, linked problems, linked changes, attached articles, major incident detection, and linked major incidents. If you enable Agent Assist recommendations, you can provide helpful recommendations to agents when a trend arises.

1. Navigate to **Similarity Analyzer > Trend Definitions**.
   You can also use the Agent Workspace Guided Setup **Search > Similarity Analyzer > Configure**.

2. Click **New** to create a new trend definition or open an existing trend definition.

3. On the form, fill in the fields.

### Trend Definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the trend definition.</td>
</tr>
<tr>
<td>Table</td>
<td>Table where you want to identify a trend.</td>
</tr>
</tbody>
</table>
| Trend type      | Type of trend configuration:  
|                 | • Common value - Identifies common values across a group of incidents. For example, say that the same value is for a resolution code.  
|                 | • Common reference - Identifies common related records in a group of incidents. For example, say that there are multiple incidents with the same problem record.  
<p>|                 | • Common condition - Identifies a condition that applies to a group of similar records. For example, say that multiple incidents apply to the same location and are all high impact. |
| Common field    | If the trend type is common value, select that field to check for duplicate values across similar records. |
| Reference type  | If the trend type is common reference, select the type of reference relationship. Choices include simple reference or M2M reference. A simple reference refers to 1-to-many or 1-to-1 relationships. For example, an incident relates to a problem, but a problem might have multiple incidents that are related to it. An M2M reference refers to a more complex relationship, such as the relationship between incidents to knowledge articles. An incident might reference many knowledge articles and a knowledge article might have many references from incidents. |
| Trend field     | If you select a simple reference, select the field to check for trend reference across similar records. |
| M2M table       | Table that you would like to identify trends in. For example, select the m2m_kb_task to look for knowledge articles that are applied to a task. |
| M2M from field  | Field that is related to the current table. For example, if you are looking for common articles that are related to an incident, this field is task. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M2M to field</td>
<td>Field that is related to the reference table. For example, if you are looking for common articles that are related to an incident, this field is kb_knowledge.</td>
</tr>
<tr>
<td>Condition</td>
<td>If the trend type is common condition, use the condition builder to create a condition to apply to a group of similar records. For example, set conditions for multiple incidents in this group that apply to the same location, are high impact and are in the same category.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope that this trend definition should run in.</td>
</tr>
<tr>
<td>Trend ID</td>
<td>ID for this trend.</td>
</tr>
<tr>
<td>Order</td>
<td>Integer value that determines the priority of this trend versus all other trends. A lower value means that there is a greater priority for the trend. If no value exists, the priority goes by alphabetic order of the trend names.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Number of duplicate values to indicate a trend.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

*Configure Agent Assist recommendations in Agent Workspace*

Configure Agent Assist to display recommended actions for agents for specified trends.

Role required: admin

After you enable and configure Predictive Intelligence and the similarity analyzer, you can define the recommended messaging, display, and actions for the specified trends. You can also prioritize that the best recommendations display when multiple trends return.

1. Navigate to **Agent Assist Recommendation > Agent Assist Recommendations**.
2. Click **New** to create a new Agent Assist recommendation or open an existing recommendation to edit the recommendation.
3. On the form, fill in the fields.

*Agent Assist Recommendation form*

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the recommendation.</td>
</tr>
<tr>
<td>Table Configuration</td>
<td>Pointer to the table configuration record.</td>
</tr>
<tr>
<td>Source type</td>
<td>Source to use for the recommendation:</td>
</tr>
<tr>
<td></td>
<td>• Script</td>
</tr>
<tr>
<td></td>
<td>• Predictive Intelligence</td>
</tr>
<tr>
<td>Solution Definition</td>
<td>Pointer to the solution definition record.</td>
</tr>
<tr>
<td>Script</td>
<td>Script that you can add to define a query that returns records for analysis.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that you can select to use this recommendation.</td>
</tr>
</tbody>
</table>
**Order**

Integer value that determines the priority of this recommendation versus all other recommendations. A lower value means that there is a greater priority for the recommendation.

---

4. Click **Submit**.

**Agent Workspace notifications**

Create the conditions when notifications appear for your agents in Agent Workspace, such as when a record updates or a record is assigned to an agent. These notifications help agents identify urgent issues.

You can alert agents about new or updated records through on-screen notifications. Workspace notifications add context to new or revised records and enable agents to link directly to the record. When a record changes, an indicator appears on any open record so that it is visible to an agent.

You can configure notification triggers that are most relevant for your team.

**Configure notification triggers in Agent Workspace**

Determine the conditions when a notification appears for your agents in Agent Workspaces such as when a record updates or is assigned to a user.

**Role required:** admin

1. Navigate to **Agent Workspace > Notification Triggers**.
2. Click **New** to create a new record or open an existing record to edit.
3. On the form, fill in the fields.

**Trigger Notifications**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Notification trigger setup configuration.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that you can select except for the system tables.</td>
</tr>
<tr>
<td>Content</td>
<td>Field that defaults to <strong>Agent Workspace UI Notifications</strong>.</td>
</tr>
<tr>
<td>When to Send</td>
<td>Notification that is sent when a record is created or updated. You can add filter conditions.</td>
</tr>
<tr>
<td>Who will receive</td>
<td>Assigned agent (if specified). You can add or remove additional agents by unlocking the users and selecting the field.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Agent Workspace Advanced Work Assignment (AWA)**

AWA automatically routes work items to agents when you set the criteria for the agent's availability, capacity, and skills. With AWA, agents can access their work item assignments from their Agent Workspace inboxes.

AWA uses service channels to organize incoming work items, such as chats, cases, and incidents. AWA routes these work items to specific work item queues, such as the product chat, billing chat, VIP chat,
critical cases, and IT support queues. You can set the capacity for an agent, which is the number of work items on a particular service channel that an agent may actively work on. You can set assignment rules to determine how AWA routes work items to a group of agents. If an agent rejects a work item, the item is rerouted to another agent.

**Note:**
The Advanced Work Assignment plugin is required for Agent Workspace.

### Service Channels

- **Chats**
- **Cases**
- **Incidents**

### Work Item Queues

- Product Chat
- Billing Chat
- VIP Chat
- Critical Cases
- IT Support

### Groups

- Assignment Rules

### Agent Options

- Agent Presence
- Reject Reasons

**AWA work flow**

**AWA Configuration Components**

**Service channels**

Agents receive work items through service channels, which are preconfigured work channels. You can customize the channel conditions, define the inbox layout for agents, create additional queues, and set the capacity for specific agents. Agent Workspace includes two preconfigured service channels, Chat and Case.
Work items

Each work item is a single piece of work that is handled by an agent, such as an incoming chat or case. Work items come through a work item queue, which has definable schedules, target wait times, and routing conditions.

Assign Groups

You can use assignment groups to group agents and provide details regarding the name and description, manager, and group email. You can use the related lists to set up roles, groups and group members, queues, and agent capacity overrides for the agent pool.

Assignment Rules

Assignment rules determine how work items, such as cases, chats, or incidents, are routed to an assignment group. You can set the criteria to assign work items to agents and create custom assignment rules to determine work item assignment and handling. You can define agent skills by using the Skills Management feature.

Agent Presence States

An agent presence state indicates if an agent is online and available to receive incoming work items or whether the agent is away or offline. You can create or modify these availability states for agents.

Reject Reasons

You can define the reasons that agents use to reject a work item, such as out to lunch or on a break.

Workspace Agent Chat

Configure Workspace Agent Chat to enable customers to ask questions and receive information through a live agent. Through Agent Chat, agents communicate with customers, create incident or case records, or transfer chats to another agent or queue.

Agent Chat uses a persistent widget for chat conversations on any portal page of the portal you're using. You can establish assignment rules to enable chat conversations to reach the best agent available who has the capacity and skills to handle the job. The agent can transfer the chat to another agent if necessary. Response templates can be used by agents to enable reusable, consistent messages to requesters.

Configure Workspace Agent Chat

Configure Workspace Agent Chat to enable live agent chat with customers. Through agent chat, agents interact with customers, create incident or case records, and transfer chats to another agent or queue.

The following should be configured before accomplishing this task:

- Install the Agent Chat plugin, com.glide.interaction.awa.
- In Advanced Work Assignment:
  - Configure service channels.
  - Define work item queues.
  - Set up work assignments.

Watch this video to get started with Workspace Agent Chat:

Role required: workspace_admin

Set up Agent Chat for agents to use chat functionality in Agent Workspace.

1. Navigate to Collaboration > Chat Setup.
2. On the form, fill in the fields.

**Chat Setup form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Live Agent setup configuration.</td>
</tr>
<tr>
<td>Live Chat Enabled</td>
<td>Option to activate live chat. If you don't want to use live agent chat, clear this check box.</td>
</tr>
<tr>
<td>CSM Fulfiller UI</td>
<td>Chat support interface: Connect Support or Agent Workspace.</td>
</tr>
<tr>
<td>CSM Queue</td>
<td>Live Agent chat queue used for Customer Service Management (CSM) if not specified in the chat interface or changed by a Virtual Agent topic. If you're using Agent Workspace, you don't need to specify a CSM queue.</td>
</tr>
<tr>
<td>HR Fulfiller UI</td>
<td>Chat support interface: Connect Support.</td>
</tr>
<tr>
<td>HR Queue</td>
<td>Live Agent chat queue used for HR if not specified through the chat interface or changed by a Virtual Agent topic.</td>
</tr>
<tr>
<td>ITSM Fulfiller UI</td>
<td>Chat support interface: Connect Support or Agent Workspace.</td>
</tr>
<tr>
<td>ITSM Queue</td>
<td>Live Agent chat support queue is used for IT Service Management if not specified through the chat interface or specified by a topic.</td>
</tr>
<tr>
<td>Global Fulfiller UI</td>
<td>Chat support interface for the platform: Connect Support or Agent Workspace</td>
</tr>
<tr>
<td>Global Queue</td>
<td>Queue used if Virtual Agent doesn't have information about the queue from the chat interface or a Virtual Agent topic. If you're using Agent Workspace, you don't need to specify a Global Queue.</td>
</tr>
<tr>
<td>Transfer Message</td>
<td>Message users see when they are transferred to a live agent or another queue. For example: &quot;Please stand by while I connect you to a live agent.&quot;</td>
</tr>
</tbody>
</table>

**Note:** Collaboration module is unrelated to the Collaboration plugin.
### No Agents Available Message

Message that users see when a live agent is not available. For example: "No agents are available at the moment. Try again later."

**Note:** You can define only one agent availability message, which is displayed for all the queues in your instance.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Agents Available Message</td>
<td>Message that users see when a live agent is not available. For example: &quot;No agents are available at the moment. Try again later.&quot;</td>
</tr>
</tbody>
</table>

### 3. Click Update.

You're almost done with Agent Chat configuration. Your final step is to enable the chat client on your end user portal, which is commonly called the Service Portal. After completing that step, you're done configuring Agent Chat.

Two options are available for setting the Service Portal chat client for Virtual Agent and Live Agent:

- **Configure the Service Portal chat client for Virtual Agent:** Define a configuration that enables the chat client to persist across all portal pages for selected portals. End users can engage in chat on any portal page in specified portals.
- **Configure the Legacy Virtual Agent Service Portal widget:** bundle/newyork-performance-analytics-and-reporting/page/administer/live-agent/task/configure-virtual-agent-for-sp.html#configure-legacySP-widget: Configure the Legacy Virtual Agent Service Portal widget: Add the Legacy Virtual Agent Service Portal widget to a single, selected portal page, from which your end users run the chat client. Use this widget if you're using pre-chat routing before users can engage in chat.

### Anonymous user chat sessions

Anonymous users (unauthenticated guests) can chat with support agents in the web chat client, without logging in to a service portal. Admins can control certain aspects of the conversational experience for guest users, such as enabling resumable chat sessions after a browser refresh.

When guest users refresh the browser window while chatting with an agent, the refresh automatically starts a new conversation and chat session. By default, the ongoing conversation and chat session history are not retained.

You can change the default guest session behavior to let your guest users resume an ongoing conversation and see the chat session history after a browser refresh.

### Enable resumable guest sessions

Use the `com.glide.cs.guest_session_resumable` system property to the change the default chat guest session behavior for guest users.

1. In the navigation filter, enter `sys_properties.list`.
2. Open the `com.glide.cs.guest_session_resumable` property.
3. In the **Value** field, enter `true` to enable resumable guest chat sessions and retain the chat session history.
4. Click Update.

After a browser refresh, your guest users can continue their conversations with agents and see the chat session history in the chat panel.
Quick actions in Agent Workspace chat

Set up shortcuts in Agent Workspace chat so agents can work more efficiently with their customers.

Using quick actions

In Agent Workspace chat, an agent can insert a quick action in any of the following ways:

- Enter a command after the forward slash (/).
- Click the lightning bolt icon
  
  and select a quick action from the menu.
- If available, click the quick action button on the toolbar.

For example, an agent can transfer a conversation to another queue by entering `/t.q` in the message input field.
Initiating a queue transfer by typing

An agent can also initiate a queue transfer by clicking the lightning bolt icon and then selecting `/tq` from the menu.
Initiating a queue transfer from the quick action menu

Alternatively, an agent can transfer to another queue by clicking the arrow button on the toolbar.
Initiating a queue transfer from the toolbar

**Note:** Agents must have the quickactions_user role to use quick actions.

**Parameters**

Some quick actions require a secondary menu so that agents can further control the quick action. For example, after an agent initiates a queue transfer, the agent needs to select which queue to transfer to. The items that appear on the secondary menu are called **parameters**.

The following figure shows that, after an agent inserts a quick action to transfer to another queue, the agent sees a list of available queues. The default parameters for the quick action are queues that are available to agents.
To create a quick action that requires a secondary menu, you must define parameters for the quick action. For more information, see Define a quick action parameter for Agent Workspace chat.

**Default quick actions**

The following quick actions are available by default with Agent Workspace chat:

<table>
<thead>
<tr>
<th>Command name</th>
<th>Toolbar button</th>
<th>Action</th>
<th>Default parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>tq</td>
<td><img src="image" alt="Transfers" /></td>
<td>Transfers the conversation to another queue.</td>
<td>Available queues</td>
</tr>
<tr>
<td>ta</td>
<td><img src="image" alt="Transfers" /></td>
<td>Transfers the conversation to another agent.</td>
<td>Available agents</td>
</tr>
<tr>
<td>r</td>
<td><img src="image" alt="Uses" /></td>
<td>Uses response templates to insert as text in a conversation.</td>
<td>Available response templates</td>
</tr>
</tbody>
</table>

**Activation information**

To enable your agents to use quick actions, you must activate the Agent Chat [com.glide.interaction.awa] plugin, which is required for chat in Agent Workspace.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
As of the New York release, quick actions replace Connect actions in Agent Workspace chat. If you activated the Agent Chat [com.glide.interaction.awa] plugin prior to New York, your Connect actions are no longer available in Agent Workspace chat; you may need to create new quick actions.

Create a quick action for Agent Workspace chat

Create a quick action so that agents can use shortcuts for performing actions in Agent Workspace chat.

Role required: admin

1. Navigate to Quick Actions > Actions, and then click New.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the quick action.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the quick action.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the quick action.</td>
</tr>
<tr>
<td>Command Name</td>
<td>Text that triggers the quick action when entered after the forward slash (/) in a conversation.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Work item that the quick action is available for. Filter the table that you select in the Table field to qualify a certain kind of work item. For example, to make the quick action available only for conversations that are assigned to Beth Anglin, you would first select the Interaction [interaction] table in the Table. Then, in the Applies to field, you would create the following filter: [Assigned to] [is] [Beth Anglin].</td>
</tr>
<tr>
<td>Table</td>
<td>Work item table that the quick action is available for.</td>
</tr>
<tr>
<td>Note: Quick actions are supported only in the Interaction [interaction] table.</td>
<td></td>
</tr>
<tr>
<td>Apply to all groups</td>
<td>Option for making the quick action available to all user groups.</td>
</tr>
<tr>
<td>Apply to groups</td>
<td>List of which groups can use the quick action. This field appears only if you clear the Apply to all groups option.</td>
</tr>
<tr>
<td>Script</td>
<td>JavaScript code to control what the quick action does. In this script, you have access to: • The record variable, which for Agent Workspace chat is the Interaction [interaction] record • The params array, if you defined quick action parameters If provided, all free-form text entered after all the other parameters are captured as the last item in the params array. Set the value of answer as follows:</td>
</tr>
</tbody>
</table>

```javascript
answer = {
  success: <Boolean>,
  message: <success_or_error_message>
};
```

Note: If you do not script a message, the agent receives a default message instead.
3. **Click Submit.**

If your quick action requires a secondary menu, define a quick action parameter so that agents can further control the quick action. For more information, see *Define a quick action parameter for Agent Workspace chat.*

Optionally, you can make the quick action available in Agent Workspace chat as a button. For more information, see *Configure a quick action button for Agent Workspace chat.*

*Define a quick action parameter for Agent Workspace chat*
Define a quick action parameter to allow agents to further control a quick action in Agent Workspace chat.

Role required: admin

1. Navigate to *Quick Actions > Parameters*, and then click **New**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the parameter.</td>
</tr>
<tr>
<td>Action</td>
<td>Quick action that uses the parameter.</td>
</tr>
<tr>
<td>No Matching Results Message</td>
<td>Message to agents if no records match the record query. If you do not create a <em>No Matching Results Message</em>, a default message is provided.</td>
</tr>
<tr>
<td>Display value field</td>
<td>Field from the parameter record that appears in Agent Workspace chat.</td>
</tr>
<tr>
<td>Query mode</td>
<td>Type of query. You can select <em>Scripted</em> or <em>Basic</em>. To query records with a script, select <em>Scripted</em>. To query records by whichever table that you specify in the <em>Table name</em> field, select <em>Basic</em>.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table to query for parameters.</td>
</tr>
<tr>
<td>No Results Message</td>
<td>Message to agents if there are no available records to query. If you do not create a <em>No Results Message</em>, a default message is provided.</td>
</tr>
<tr>
<td>Value field</td>
<td>Field from the parameter record that agents can enter in Agent Workspace chat to invoke the parameter item. For example, to transfer a conversation to Beth Anglin, an agent would enter <code>/ta &quot;beth.anglin&quot;</code>. In this case, the <em>User ID</em> field in the User [sys_user] record is the <em>Value field</em>.</td>
</tr>
</tbody>
</table>

This field appears when you select *Basic* in the *Query mode* field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Script</td>
<td>JavaScript code to determine which records qualify for your parameter.</td>
</tr>
<tr>
<td></td>
<td>You are given a query variable that represents the search query that the</td>
</tr>
<tr>
<td></td>
<td>agent provided. Set the value of the answer variable as follows:</td>
</tr>
<tr>
<td></td>
<td>answer = {</td>
</tr>
<tr>
<td></td>
<td>items: [ { value: &lt;value&gt;, displayValue: &lt;displayValue&gt;} ]</td>
</tr>
<tr>
<td></td>
<td>};</td>
</tr>
<tr>
<td></td>
<td>The array of items should contain objects with a value and a displayValue.</td>
</tr>
<tr>
<td></td>
<td>Note: This field shows only if you select Scripted in the Query mode field.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the parameter.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the parameter is available for the quick action.</td>
</tr>
</tbody>
</table>

**3. Click Submit.**

*Configure a quick action button for Agent Workspace chat*

Configure a quick action button so that agents can perform actions in Agent Workspace chat with a single click.

Role required: admin

The toolbar of the Agent Workspace chat window contains three buttons. By default, clicking the left button

(_attach a file in a conversation, clicking the center button

(initiates a queue transfer, and clicking the right button

(initiates an agent transfer. You can't configure the left button, but you can assign different quick actions to the center and right buttons. However, you can't change the button icons.
1. Navigate to **Collaboration > Chat Setup**.
2. Go to the Quick Actions for Workspace Actions related list and select a button to configure.
   - To configure the arrow button
     open `arrow-right-outline`.
   - To configure the add user button
     open `user-plus-outline`. 
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Action</td>
<td>Quick action that is inserted when you click the button.</td>
</tr>
<tr>
<td>Icon</td>
<td>Button icon that appears on the toolbar of the Agent Workspace chat window.</td>
</tr>
<tr>
<td></td>
<td>You can't change the button icon.</td>
</tr>
<tr>
<td>Order</td>
<td>Position of the button on the toolbar. If the value is 100, the button</td>
</tr>
<tr>
<td></td>
<td>appears at the center of the toolbar. If the value is 101, the button</td>
</tr>
<tr>
<td></td>
<td>appears at the right side of the toolbar. You can't change the button order.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Configuring Agent Workspace landing pages**

The Agent Workspace landing page is the initial view of your agent's workspace. It displays a set of preconfigured reports and grouped data that are specific to your agent's work responsibilities.

Your instance should have at least one landing page, depending on the features and products that you have. All landing pages are configurable and consist of a layout with containers and widgets that appear on the page. You can use any landing page without modifications or you can clone a landing page and make updates for your installation.

**Note:** Widgets that display in Agent Workspace must be pre-configured. If you need to configure a widget, see **Performance Analytics and Reporting for Agent Workspace**.

Components and behavior include:

- **Lists:** Displays a list with any selected record that opens in a new tab. Clicking **Show All** displays the full list in the home module.
- **Single Score:** Displays a full list in the home module.

**Note:** A database view, such as Spotlight, will not have other interactions.

- **Time Series/Trend By:** Displays a graph of records over time or a trend but does not contain other interactions.
### Happening Now

<table>
<thead>
<tr>
<th>Category</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open P1 Incidents</td>
<td>24</td>
</tr>
<tr>
<td>Incident SLA Breached</td>
<td>20</td>
</tr>
<tr>
<td>Incident SLA at Risk</td>
<td>0</td>
</tr>
<tr>
<td>Unassigned Incidents</td>
<td>8</td>
</tr>
</tbody>
</table>

### My Work

<table>
<thead>
<tr>
<th>Number</th>
<th>Created</th>
<th>Priority</th>
<th>State</th>
<th>Short Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC0000059</td>
<td>2016-08-10 09:14:29</td>
<td>3 - Moderate</td>
<td>In Progress</td>
<td>Unable to access team file share</td>
</tr>
<tr>
<td>INC0007001</td>
<td>2018-10-16 22:47:45</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td>Employee payroll application server is down.</td>
</tr>
<tr>
<td>INC0007002</td>
<td>2018-10-16 22:48:24</td>
<td>4 - Low</td>
<td>In Progress</td>
<td>Need access to the common drive.</td>
</tr>
<tr>
<td>INC0008001</td>
<td>2018-09-11 20:57:01</td>
<td>3 - Moderate</td>
<td>In Progress</td>
<td>Unable to post content on a Wiki page</td>
</tr>
<tr>
<td>INC0006005</td>
<td>2018-08-31 21:35:45</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td>Email server is down.</td>
</tr>
<tr>
<td>INC0008009</td>
<td>2018-08-30 01:06:52</td>
<td>4 - Low</td>
<td>In Progress</td>
<td>Unable to access the shared folder.</td>
</tr>
<tr>
<td>INC0010024</td>
<td>2019-05-06 09:03:15</td>
<td>4 - Low</td>
<td>In Progress</td>
<td>I can't access my email</td>
</tr>
</tbody>
</table>

Show all
Modify the landing page layout for Agent Workspace

Modify or create a new landing page for Agent Workspace. If you modify an existing landing page, the clone of the landing page copies the layout and all associated containers and widgets.

Role required: Uxframework_designer

You must be in the Agent Workspace application.

1. Navigate to Agent Workspace > Landing Pages.
2. Create a landing page or modify an existing landing page:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify an existing landing page</td>
<td>Go to step 3. You should have a default landing page and other customized landing pages for specific features or products.</td>
</tr>
<tr>
<td>Create a landing page</td>
<td>Click New and go to step 5.</td>
</tr>
</tbody>
</table>

3. Select a landing page.
4. Click Clone Page.
5. On the form, fill in the fields.

Landing page attributes and layout form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your landing page.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the page shows. If you set up multiple landing pages, the page with a lower value takes precedence over the pages with higher values.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If there are permissions on any active page, a user sees the page with their group or role set. The permissions takes precedence over a user who sees a page without permissions that is the lowest order.</td>
</tr>
<tr>
<td>Applicability</td>
<td>If applicability is for any page or a specific page.</td>
</tr>
<tr>
<td>Applicable Page Registry</td>
<td>If applicability is for a specific page, identify the page from the UX page registry.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that you select to determine whether the landing page appears. A page that is not active does not appear.</td>
</tr>
<tr>
<td>Optional Page Title</td>
<td>Title to display on the page.</td>
</tr>
<tr>
<td>Available Child Slots</td>
<td>Pre-defined named location for child elements.</td>
</tr>
<tr>
<td>Layout</td>
<td>Pre-defined list of containers to define the number of slots (columns) that display on a layout.</td>
</tr>
</tbody>
</table>

6. Click Update.
7. Configure permissions for users to access the landing page:
   a) Click the UX Page Element Permissions related list.
   b) Click **New**.
   c) Select the role or group for the landing page to be visible.
   d) Click **Submit**.

Any page element (including sub-elements) can have a restriction to a given set of roles or groups. If no element permissions are set on roles or groups, all users see the element. If some element permissions are set, a user needs just one role or group assignment to see the element.

8. Configure a container:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add a container</strong></td>
<td>Click <strong>New Container</strong>.</td>
</tr>
<tr>
<td><strong>Modify an existing container</strong></td>
<td>Select an existing container.</td>
</tr>
</tbody>
</table>


**Container attributes and layout form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your container.</td>
</tr>
<tr>
<td>Component</td>
<td>Component that defaults to sn-page-container.</td>
</tr>
<tr>
<td>Parent element</td>
<td>Landing page where your container resides.</td>
</tr>
<tr>
<td>Slot</td>
<td>Component placement within the parent element's slot configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the container shows.</td>
</tr>
<tr>
<td>Border</td>
<td>Option to select a border around your container.</td>
</tr>
<tr>
<td>Optional Container Title</td>
<td>Title to display on the container.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of styling for your visualization. You can choose the default styling (no background color) or visualization styling (gray background).</td>
</tr>
<tr>
<td>Available Child Slots</td>
<td>Pre-defined list of containers to define the number of slots (columns) that appear in a layout.</td>
</tr>
<tr>
<td>Layout</td>
<td>Column layout on the page.</td>
</tr>
</tbody>
</table>

10. Configure a widget:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add a widget</strong></td>
<td>Click <strong>New Visualization</strong>.</td>
</tr>
<tr>
<td><strong>Modify an existing widget</strong></td>
<td>Select an existing widget.</td>
</tr>
</tbody>
</table>

11. On the form, fill in the fields.

**Widget attributes and layout form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your widget.</td>
</tr>
<tr>
<td>Component</td>
<td>Name of the component.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parent element</td>
<td>Container where your widget resides.</td>
</tr>
<tr>
<td>Slot</td>
<td>Component placement within the parent element's slot configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the component shows.</td>
</tr>
<tr>
<td>Report</td>
<td>Report that you want to render:</td>
</tr>
<tr>
<td></td>
<td>• Single score</td>
</tr>
<tr>
<td></td>
<td>• Trend by</td>
</tr>
<tr>
<td></td>
<td>• List</td>
</tr>
<tr>
<td>Note:</td>
<td>Choose and populate either Report or PA Widget, but you cannot display both.</td>
</tr>
<tr>
<td>PA Widget</td>
<td>PA Widget that you want to render:</td>
</tr>
<tr>
<td></td>
<td>• Single score</td>
</tr>
<tr>
<td></td>
<td>• Time series</td>
</tr>
<tr>
<td>Note:</td>
<td>Choose and populate either Report or PA Widget, but you cannot display both.</td>
</tr>
<tr>
<td>Optional Widget Label</td>
<td>Title to display with the widget.</td>
</tr>
<tr>
<td>Size Variant</td>
<td>Option to select the size of the widget:</td>
</tr>
<tr>
<td></td>
<td>• Small</td>
</tr>
<tr>
<td></td>
<td>• Medium</td>
</tr>
<tr>
<td></td>
<td>• Large</td>
</tr>
<tr>
<td></td>
<td>• Extra Large</td>
</tr>
<tr>
<td>Note:</td>
<td>Not all sizes apply to all widgets.</td>
</tr>
<tr>
<td>Border</td>
<td>Option to select a border around your widget.</td>
</tr>
<tr>
<td>Refresh Interval</td>
<td>Number of minutes before a widget refreshes with new data. The interval begins when a user navigates away from a landing page and ends when the user comes back to the landing page.</td>
</tr>
<tr>
<td>Note:</td>
<td>There is no auto-refresh, but a user can click a refresh button at any time.</td>
</tr>
<tr>
<td>Visualization SysID</td>
<td>Designated ID for the widget.</td>
</tr>
<tr>
<td>Report Type</td>
<td>Type of report that renders.</td>
</tr>
</tbody>
</table>
Agent Workspace phone integration with OpenFrame and computer telephony integration (CTI)

OpenFrame and CTI enable third-party phone integrations for phone use for agents in Agent Workspace.
- OpenFrame enables CTI with third-party telephony service providers (TSPs) such as Twilio.
- CTI integrates with the Now Platform and the TSPs to support incoming and outgoing calls.

When you integrate OpenFrame and CTI with a TSP, agents in Agent Workspace can use:
- An embedded softphone to place and receive customer calls.
- Click-to-call capability from phone number fields on forms and the Customer 360 ribbon component.
- Contextual identification for incoming calls.
- An additional window that contains contextual links in the softphone window and open related records.

OpenFrame and CTI can also integrate with the Interaction Management System (IMS), which enables you to manage the life cycle of the phone interaction. With this integration, incoming and outgoing calls create phone interaction records.

Use embedded softphones with Agent Workspace

Configure Agent Workspace to support embedded softphones so that agents can receive incoming calls and place outgoing calls.

Incoming calls

Agents receive incoming calls in the OpenFrame window. Contextual information, such as the account, contact, consumer, and case number, is displayed in the window.

Agents click links from the contextual information in the OpenFrame window to open the corresponding records in Agent Workspace. Agents can open the forms in primary or child tabs depending on the workspace tab configuration.

- With Interaction Management System (IMS) integration, these records open as sub-tabs to the interaction record.
- Without IMS integration, these records open as primary tabs.

For more information, see the OpenFrame overview overview.

Outgoing calls

Agents can place outgoing calls from phone number fields on a form or from the ribbon on the Case form.

By clicking these phone fields, agents see the OpenFrame window, where they can place a call to the number which shows on-screen.

Integration with Interaction Management System (IMS)

With OpenFrame, computer telephony integration (CTI), and IMS integration, incoming and outgoing calls create interaction records.

Receive incoming calls through Agent Workspace

When an agent answers an incoming call from the OpenFrame window, an interaction record opens in a parent tab in the New state with the Channel field set to Phone.
If available for your installation, the account information, the contact information, or the consumer information, is added to the interaction record. The case number is also added to the record if the caller provides it to the agent. If an agent clicks a link in the OpenFrame window, such as the account, contact, consumer, or case number, the corresponding record opens in a sub-tab under the interaction record.

The call forwards to an agent. The interaction record is assigned to the agent and the state is set to Pending Acceptance. The interaction record is displayed in the agent's workspace and includes any details that are provided by the customer.

The agent can accept or reject the call:

- If accepted, the interaction record state is set to Work in Progress.
- If rejected, the interaction record state is set to Closed Complete.
- If the call is not picked up or the caller hangs up before the agent can pick up, the interaction state is set to Closed Complete.

When a call is ended, a phone log record is created for the interaction and the interaction record state is set to Closed Complete.

Make outgoing calls through Agent Workspace

For outgoing calls, the `sn_openframe.create_interaction` property determines whether or not an interaction record is created.

When an agent places an outgoing call using a click-to-call enabled phone field, the system gathers contextual information about the call, including the account, contact, or consumer details.

If the `sn_openframe.create_interaction` property is set to true:

- An interaction record is created in the Work in Progress state. The record is populated with the contextual information and is assigned to the agent.
- The interaction record and relevant information is passed to OpenFrame.
- CTI receives the interaction, initiates the call, and manages the interaction life cycle.
- If the outgoing call is unanswered, the interaction record is set to Closed Complete.

If the `sn_openframe.create_interaction` property is set to false:

- The contextual information is passed to OpenFrame.
- CTI receives the contextual information and initiates the call.

Transferring calls to other agents

If an agent transfers a call to another agent, the interaction record is also transferred and a transfer record is created. The call is shown in the OpenFrame window in the new agent's workspace. The interaction record is assigned to the new agent in the Pending Acceptance state and is displayed in the agent's workspace. The state changes to Work in Progress when the agent accepts the call.

Integration with Interactive Voice Response (IVR)

With IVR integration, an interaction record is created as soon as the caller connects and receives an IVR message. The selections made by the caller are captured and added to the interaction record. If the caller enters a case number, the case is added as a related record on the interaction.
Completing your tasks with Agent Workspace

With Agent Workspace, you can respond to users, maintain context while opening several tabs, and find the answers to questions without leaving the form that you are working on.

You can customize Agent Workspace to fit the way you work best.

Agent Workspace customization

Customize Agent Workspace to match your workflow needs.

Customize your Agent Workspace

Make Agent Workspace work for your workflow by customizing preferences, create tags, and creating filters to find your records.

- Set your user preferences in Agent Workspace to customize the ribbon, sidebar, and banners. You can also wrap list text and show a notifications badge count.
- Set record tags in Agent Workspace to organize and group records.
- Create a filtered list in Agent Workspace to monitor your issues, tasks, or problems. Filters appear under My Lists.

Set your user preferences in Agent Workspace

Configure Agent Workspace to display settings that are important to your workspace.

Role required: agent_workspace_user

1. Navigate to Agent Workspace > Agent Workspace Home.
   Agent Workspace opens in a new tab.
2. Navigate to User Menu > Settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Ribbon</td>
<td>Enables the workspace to show the Ribbon widget by default when the form loads.</td>
</tr>
<tr>
<td>Show Sidebar</td>
<td>Enables the workspace to show the contextual sidebar by default when the form loads.</td>
</tr>
<tr>
<td>Wrap List Text</td>
<td>Enables the workspace to automatically wrap the List text lines to save space on the workspace screen.</td>
</tr>
<tr>
<td>Show Banners</td>
<td>Enables agents to opt into or out of notification pop-up displays.</td>
</tr>
<tr>
<td>Show Badge Count</td>
<td>Enables agents to opt into or out of a count of incoming notifications.</td>
</tr>
</tbody>
</table>

Set record tags in Agent Workspace

Customize your workspace by adding record tags, which are text labels to group and organize records, in Agent Workspace.

Role required: admin

1. Navigate to any open record in Agent Workspace.
2. Click the Tag icon

next to the primary value in the form header.

3. In **Add Tag**, enter a tag name.

4. Click **Enter** to save the tag with the record.

You can continue to add more tags, if desired.

The tag visibility setting defaults to private, which is only visible to the owner of the record.

5. To change the visibility setting of the tag, select a tag and change the **Viewable by** setting:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Me</td>
<td>This setting is for a private tag and is visible only to the owner of the record. This setting is the default.</td>
</tr>
<tr>
<td>Groups and Users</td>
<td>This setting is for a shared tag which is visible to specific groups or users. You can specify the groups and users who can view this tag.</td>
</tr>
<tr>
<td>Everyone</td>
<td>This setting is for a global tag which is visible to everyone.</td>
</tr>
</tbody>
</table>

**Note:** This visibility setting is only available to an admin or tags_admin role.

6. To remove a created tag, click a filled Tag icon and click the X on the tag.
Create a filtered list in Agent Workspace

Create your own filtered lists in Agent Workspace to monitor your issues, tasks, or problems, under **My Lists**.

Role required: agent_workspace_user

1. Navigate to **Agent Workspace > Agent Workspace Home**. Agent Workspace opens in a new tab.
2. In **Lists**, select a pre-defined list, and then click the Edit Menu icon.
3. Click **Save as** and rename the list. The new list appears in the **My Lists** section of the List menu.
4. Optional: To edit an existing list under **My Lists**, click the **Edit Menu** icon to enter edit mode, and then click the list that you want to edit.
5. Optional: To copy a list from either **Lists** or **My Lists**, click the **Edit Menu** icon to enter edit mode and then the Copy List item icon next to the list you want to copy.
6. Optional: To change the order of your lists, enter edit mode, then drag each list into the order that you want.

List menu in Agent Workspace

Use the list menu in Agent Workspace to see which cases are assigned to you and to make lists that only you can see. Lists are organized into two categories: Lists and My Lists.
Lists

Categorized set of lists are created by the workspace list administrator. You only see the categories and lists that are assigned to you. If no lists are configured for a list category, the list category does not appear in the list panel.

Configure your own versions of the lists in this section by entering edit mode ( ), copying a configured list, and making your own adjustments.

Expand and collapse categories to make it easier to find the lists that you want.

My Lists

Any lists that you create appear in this section. Lists in this section are not visible to anyone but you. Use the edit menu for the following:

Rename
Enables you to rename a list.

Personalize Columns
Allows you to alter the columns that are displayed in the list.

Save
Saves the current list and underlying filters.

Save as
Saves and renames the current list and underlying filters under My List.

Delete
Removes a user-created list from My List.

Starting work with Agent Workspace

An agent begins work in a list queue, chat queue, or phone call.

Agent Workspace channels

Typically, there are three avenues to start work in Agent Workspace:

• Starting from the List queue
• Starting from the Agent Inbox
• Starting from a phone call
## Starting from the List queue

<table>
<thead>
<tr>
<th>Agent Responsibilities</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a queue in the List queue</td>
<td>The List queue contains both preconfigured lists and a My Lists section.</td>
</tr>
<tr>
<td>Monitor list queue</td>
<td>The Lists queues are set up to highlight queues specific to a workspace. A typical setup includes:</td>
</tr>
<tr>
<td></td>
<td>• Cases</td>
</tr>
<tr>
<td></td>
<td>• Customer</td>
</tr>
<tr>
<td></td>
<td>• Tasks</td>
</tr>
<tr>
<td></td>
<td>• SLAs</td>
</tr>
<tr>
<td></td>
<td>• Incidents</td>
</tr>
<tr>
<td></td>
<td>• Requests</td>
</tr>
<tr>
<td></td>
<td>• Catalog Tasks</td>
</tr>
<tr>
<td>Review specifics on a customer and issue</td>
<td>The Form header and ribbon give a quick look at customer information and a short description view of an issue.</td>
</tr>
<tr>
<td>Review the activity stream</td>
<td>The activity stream shows the communications and work done for a customer.</td>
</tr>
</tbody>
</table>

## Working from an Agent Inbox

<table>
<thead>
<tr>
<th>Agent Responsibilities</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receive a work item in your inbox</td>
<td>You can receive these types of work items:</td>
</tr>
<tr>
<td>Work an interaction message</td>
<td>A live chat is tied to an interaction message which logs customer communications.</td>
</tr>
<tr>
<td>Open or review the customer and issue information</td>
<td>The Form header and ribbon give a quick look at customer information and a short description view of an issue.</td>
</tr>
<tr>
<td>Review the activity stream</td>
<td>The activity stream shows work done for a customer through the life cycle of the issue.</td>
</tr>
</tbody>
</table>
Working from a phone call

<table>
<thead>
<tr>
<th>Agent Responsibilities</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answer a phone call</td>
<td>The workspace enables phone calls for agents from the phone icon or a customer phone number.</td>
</tr>
<tr>
<td>Work an interaction message</td>
<td>A phone call is tied to an interaction message which logs customer communications.</td>
</tr>
<tr>
<td>Open or review the customer and issue information</td>
<td>The Form header and ribbon give a quick look at customer information and a short description view of an issue.</td>
</tr>
<tr>
<td>Review the activity stream</td>
<td>The activity stream shows work done for a customer through the life cycle of the issue.</td>
</tr>
</tbody>
</table>

Global search capabilities in Agent Workspace

The global search feature enables searches for case, incidents, problems, knowledge articles, community questions and change requests.

Global search feature

Users can search on a term and view the search results in a separate tab. The search results include items in which the short description, content, or attached files include the search term. By default, global search results can include:

- Cases
- Customers or Users
- Community Questions
- Incidents
- Change Requests
- Problems
- Knowledge Articles

Searching for a customer or user

You can search for a customer or user by name, for example, search for a user or customer with the first name of Fred:

![Search bar with text 'fred']

Global search results show the number search results by designated categories:
By clicking Users, the results show for users with the name of Fred:

Users (2 of 2) ①

Fred Luddy
fred.luddy@example.com
ACME North America

Fred Kunde
fred.kunde@example.com
ACME France

Searching for a case or incident

You can search for specific cases or incidents by the case or incident number. If you do not know the specific case or incident number, you can also search by user or customer. A search for incidents involving Fred:
Interaction records in Agent Workspace

Using an interaction record, agents can create or reference basic information from a customer contact. Agents can then decide if the conversation is an incident, a case, or a request.

An interaction represents a request for assistance made through a given channel (chat, phone, walk-up). Interactions can be routed to queues for assignment or assigned to agents directly. Support agents can create cases, requests, or incidents from the interaction. Interactions can also be used to capture one-and-done type requests where an agent might not want to create associated tasks.
### Features

<table>
<thead>
<tr>
<th>Features</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details, Related Tasks, User's Interactions forms</td>
<td>Every interaction record defaults to the Details form, showing initial interaction record information. Related Tasks are tasks opened from the interaction, for example, a new incident. The User's Interactions form logs all interactions tied to each specific user.</td>
</tr>
<tr>
<td>Number</td>
<td>A number is associated to each customer interaction.</td>
</tr>
<tr>
<td>Features</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Logs the type of channel communication, such as chat, phone, or walk-up.</td>
</tr>
<tr>
<td></td>
<td>Note: Phone is an available type of channel communication when the OpenFrame plugin (com.sn_openframe) is activated.</td>
</tr>
<tr>
<td><strong>State</strong></td>
<td>The state of the interaction record. Choices include:</td>
</tr>
<tr>
<td></td>
<td>• Queued</td>
</tr>
<tr>
<td></td>
<td>• Pending Accept</td>
</tr>
<tr>
<td></td>
<td>• New</td>
</tr>
<tr>
<td></td>
<td>• Work in Progress</td>
</tr>
<tr>
<td></td>
<td>• Closed Complete</td>
</tr>
<tr>
<td></td>
<td>• Closed Abandoned</td>
</tr>
<tr>
<td><strong>Opened for</strong></td>
<td>The customer who initiates or receives the communication.</td>
</tr>
<tr>
<td><strong>Assigned to</strong></td>
<td>The agent the interaction record is assigned to.</td>
</tr>
<tr>
<td><strong>Wait time</strong></td>
<td>The time it takes to initially respond to the customer.</td>
</tr>
<tr>
<td><strong>Short Description</strong></td>
<td>A short description of the interaction.</td>
</tr>
<tr>
<td></td>
<td>Note: The short description field is empty by default, but it cannot be empty when the record is closed, saved, or associated to a related task. Populate the short description and then close, save, or associate the record, or you cannot archive the record.</td>
</tr>
</tbody>
</table>

**Agent Workspace notifications**

Agents can receive Agent Workspace notifications so they are aware of updates to their records without leaving their workspace.

Agents can view on-screen notifications from administrator configured triggers, such as a notification for the “assigned to” agent of a newly assigned or updated record. These notifications give context to the change and enable agents to link directly to the record. Also, more noticeable tab indicators on record change for off-focus open records. Benefits include:

- On-screen notification pop-up, for newly assigned or updated records
- A notification icon and badge
- Notification tray which retains notifications for the last seven days (unless manually cleared by the user)
- New settings to opt into or out of notification toasts and notification badge count
Working from the List queue

Open a list from the List menu to view a list of items in the workspace.

Working from the List enables you to see high-level information for all of your records.
You can perform numerous tasks from the List in the workspace to quickly find the information you are seeking, such as sorting and filtering columns, and grouping items.

**Sorting columns**

Click the column headings to determine the sort order of a column. The arrow next to the column name indicates the current sort order. A downward pointing arrow indicates that the column sorts in a descending order. The system remembers the most recent sort order that you choose for a specific column.

Click the **More UI Actions** icon

![More UI Actions icon](image)

... to **Show Matching** records or **Filter Out** matching records from the list.

By default, a column sorts in an ascending order unless the column data type is a date. Dates sort in a descending order.
Changing the number of rows per page

In the list footer, click the number of rows per page

20 rows per page

and select the number of rows that you want to display.

List quick edit

You can make updates to a record directly from a list, without leaving the list. Click the Open Preview icon to open the record for edits.

Note: This feature is available only on a full list view, not a related list.

List multi-edit

You can apply the same changes to multiple records at the same time directly from the list. Select the records for your global edits. The Edit button shows an aggregate total of the records selected. Make changes and click Update to save. The number of records you can update cannot extend past the page.

Note: This feature is available only on a full list view, not a related list.

List grouping

You can group your list by a single column. Click the More UI Actions icon to apply a filter for grouping. You can also save this view to My Lists by grouping the list, and clicking Save. When you access this list from My Lists, the grouping filter applies.
After a list group filter applies, the pagination also updates. The display shows a count of rows per group. The maximum number of groups that display per page is 20. You can adjust this count to change the number of records displayed in each group.

**List column filtering**

You can filter a list from a column header without having to open the Advanced Filter panel. Click the More UI Actions icon

- to the right of the column and set filter your conditions. Click Apply to see your filter in the list.
List export

You can export records from a list into CSV, XLSX, JSON, or PDF files. Click the List Actions icon and select Export.

List updates

Last refreshed indicates the time period since the last data refresh on screen. View the changes by refreshing the list. Related list counters do not get updated automatically, so you must refresh the browser to see an accurate count.

List filter badges

The list filter icon displays badges that show the number of conditions that apply to the current list. You can restore the defaults to a list to remove additional filters on the original filter list. The advanced view launches the condition builder.

List URLs

Each list has an associated URL, similar to records. You can bookmark a list to allow quick access and deep-linking from the platform UI directly to a workspace list.
Create a record in Agent Workspace
Create a record in Agent Workspace from the New Record menu or from a list.

Depending on your workspace configuration, you might not see the options.

Role required: agent_workspace_user

1. Create a record using one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Record menu</td>
<td>Click the New Record menu icon tab to create a record. If more than one record option is available, select the type of record that you want to create. If you do not select a record type, a new interaction record opens automatically.</td>
</tr>
<tr>
<td>List Panel</td>
<td>From the List menu, select a queue under the list category that you want to create a record for, and then click New. Depending on your configuration, the New button might not be available.</td>
</tr>
</tbody>
</table>

2. On the form, fill in the fields.

If another user makes changes to the same record, you see a visual indicator next to the changed fields.

Apply a template to a record in Agent Workspace
Select a template for a form that you use frequently from the contextual sidebar to automatically populate fields on the form.

Role required: agent_workspace_user

1. In Agent Workspace, open an existing record from a list, or create a record.
2. From the contextual sidebar, click the template icon.
3. From the list of templates, select a template to apply to the form. Any fields that are included in the template automatically populate in the form.
4. Optional: To undo the changes that were made when you added the template, navigate away from the form without saving.

Using Agent Assist in Agent Workspace
Agent Assist is a contextual search option that agents use to search for additional information.

Search results automatically appear when you use the search bar in Agent Assist to search for information. Depending on your installation, Agent Assist enables the following options:

- Predictive Intelligence
- Knowledge articles
- Attachments
- Templates
Agent Assist

ServiceNow Predictive Intelligence can help you to find similar incidents and problems by using a combination of contextual search, Azul Systems, Inc Zing, and machine learning.

**Note:** Machine learning and Major Incident Management require separate subscriptions.

Depending on your configuration, Agent Assist search results can include knowledge articles, social Q&A entries, and catalog items. The default number of search results is 10. If you see more than 10 results, the number appears as 10+. Use the filter to narrow down your search results.

If **Search as** is enabled for Agent Assist for your instance, you can also filter search results by caller name. That way, you know that the caller can also see the articles that you are attaching.

You can place a catalog order directly from the form by clicking the catalog item in Agent Assist. You can also add a knowledge article to the Additional comments (customer facing) activity stream for a record by clicking **Attach** in Agent Assist.

For Agent Assist to work, the ITSM plugin, com.snc.agent_workspace.itsm, must be activated on your instance.

**Order a catalog item using Agent Assist**

Use Agent Assist to order catalog items from within the form.

**Role required:** agent_workspace_user

1. Navigate to **Agent Workspace > Agent Workspace Home.**
2. Open an incident record from the list of open incidents.
3. In the Agent Assist panel, select an item from the default search or search for something specific in the search bar.
4. Click the catalog item, and then click **Order**.

Catalog item

The form for the catalog item opens in a new sub-tab.
5. Complete the catalog item form.

<table>
<thead>
<tr>
<th>INC0000057</th>
<th>INC0000055</th>
<th>+</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>DevelopmentLa...</td>
<td>x</td>
</tr>
</tbody>
</table>

- Service Catalog > Hardware > Development Laptop (PC)

Catalog item form

Ordering the catalog item creates a service catalog request.

*Add a knowledge article to a form using Agent Assist*

Use Agent Assist to search for and add articles to a form.

Role required: agent_workspace_user

1. Navigate to **Agent Workspace > Agent Workspace Home**.
2. Open an incident record from the list of open incidents or cases.
3. In the Agent Assist panel, select an item from the default search or search for something specific by using the search bar.

4. Click **Attach**.

Depending on your configuration, when you click **Attach**, you add a link or embed an article directly into the Additional comments (customer visible) portion of the activity stream.
Working from the agent inbox

Use the agent inbox to manage your incoming work items, such as chats, cases, and incidents.

To open the agent inbox, click **Inbox** in the navigation bar.

### Inbox responsibilities

<table>
<thead>
<tr>
<th>Agent responsibilities</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor your inbox</td>
<td>Use designated service channels to route work items to available agents, such as incoming chat requests, case assignments, and incidents.</td>
</tr>
</tbody>
</table>
| Start a chat session                       | Accept a chat from your inbox. You have a time limit to accept a chat before it reroutes to another agent. The chat associates to an interaction record that captures the conversation and work done during the session. During a chat session, you can:  
  - Add attachments using the Action toolbar.  
  - Transfer the chat to another agent.  
  - Add another agent to the chat.  
  - Perform other support tasks, such as create an incident or case.  
  - Use workspace tools, such as the ribbon to glance at information or the activity stream to review related work. |

### Agent inbox navigation

![Agent inbox navigation](image-url)
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(A) Agent inbox</td>
<td>Display the queues that are assigned to you, the number of active chats in each queue, and the average wait time for chats in the queue.</td>
</tr>
<tr>
<td>(B) Active chat panel</td>
<td>Display your active chat session. Chat actions appear beneath the chat and allow your agents to attach a file, add an agent, transfer the chat, and more.</td>
</tr>
<tr>
<td>(C) Interaction record</td>
<td>Display the interaction record (IMS). The IMS initiates from a chat or phone call and lists the initial information about the customer and the communication. You can archive this interaction as a log of communication, or you can create an incident or a case that is based on the customer needs.</td>
</tr>
<tr>
<td>Attachments panel</td>
<td>Add attachments to the interaction. For example, you can add supporting information to a customer issue. If templates are available, they appear in the template section of this panel.</td>
</tr>
</tbody>
</table>

**Accept a chat session**

Begin a conversation with a customer by selecting a chat queue in the chat session. You can work on multiple chats in different queues simultaneously.

Role required: agent_workspace_user

1. Navigate to **Agent Workspace Home > Inbox**.
2. From your inbox, accept or reject a chat.

You are automatically connected to the first customer in the chat queue, which is the oldest request in the queue. The Active Chat panel displays a pre-chat message acknowledging the customer chat request. You can review the customer information before you enter a response in the Active Chat panel.

In the chat workspace, an interaction parent tab with a details child tab open for the session. The details child tab offers more information on the chat request and provides contextual options for performing related operations during the chat session.

3. Use chat tools for managing the chat and contextual options to perform related tasks.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage your chat</td>
<td>Do the following actions from the Actions toolbar:</td>
</tr>
<tr>
<td></td>
<td>• Add an attachment.</td>
</tr>
<tr>
<td></td>
<td>• Transfer a chat to another queue.</td>
</tr>
<tr>
<td></td>
<td>• Transfer a chat to another agent.</td>
</tr>
</tbody>
</table>
### Option | Description
--- | ---
Perform additional support tasks | Engage in other support work during the chat session by using the contextual options in the **Details** tab. For example, you can:  
- Update chat information.  
- Create a new case or incident.  
  From the sub-tab, you can select other contextual options to work on a resolution for the case or incident. For example, you might need to escalate the issue.  
- Choose a related task in the More options (….), such as send email.  
- Search for relevant information in the knowledge base using Agent Assist.  
  
4. In the **Details** tab of the interaction, end the chat session by clicking **Close**.  
Ending the chat saves the conversation history and closes out the interaction. You can also end a chat by closing the tab. If you end the chat this way, you lose all of the conversation history and you cannot save the information in the interaction record.  

**Add an attachment to a chat**  
Chat agents can add attachments, such as documents and image files, to the conversation.  
Role required: `agent_workspace_user`  
- From the Action toolbar, click the Attachment icon ( ![Attachment](attachment_icon.png)) to upload an attachment to the case.  

**Transfer a chat to another queue**  
Route a chat to another queue. Any agent who belongs to the associated queue can accept the chat.  
Role required: `agent_workspace_user`  
1. From the Action toolbar, click the Transfer to Queue icon ( ![Transfer to Queue](queue_icon.png)).  
2. In the Transfer to Queue panel, select the queue to transfer the chat to.  
   When you transfer a chat, the current work item associated with the interaction is marked as closed complete. A new work item is associated with the new queue and the chat is added to the selected queue. When a receiving agent accepts the transfer, that agent sees the conversation and the chat history in the Active Chat panel.  

**Transfer a chat to another agent**  
Route a chat to another agent in the same service channel.  
Role required: `agent_workspace_user`  
1. From the Action toolbar in the Active chat panel, click the Transfer Agent icon ( ![Transfer Agent](agent_icon.png)).
2. In the Transfer to Agent window, select the agent to receive the chat.

![Transfer to Agent window](image)

The transferred chat is listed in the Queues panel for the receiving agent. The receiving agent can accept or decline the transfer request.

**Change your status in the chat panel**

Change your status while you are on a break or offline so no new chats are assigned to you. When you return, you can update your status to let everyone know you are back.

Role required: agent_workspace_user

1. Navigate to **Agent Workspace Home > Chat**.
2. In the chat panel, from the status list, select your current status.
   - **Available**: You are available to receive new chats.
   - **Away**: You are not available to receive new chats.
   - **Offline**: You are not available to receive new chats.

Adjust your status depending on your availability.

**Using a phone in Agent Workspace**

Use Agent Workspace to make inbound and outbound telephone calls if your instance is integrated with your telephony system.

Role required: agent_workspace_user

You can do the following with the Agent Workspace phone:

- Make an outgoing call
- Receive an incoming call
- Transfer a call to another user within the system
- Place a call on hold or on mute
- Set your availability status

1. Do one of the following:
2. Click **End** to end the call.

### Domain separation and Agent Workspace

This is an overview of domain separation and Agent Workspace. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Overview**

Domain separation is not supported in this application. For more information, see [Application support for domain separation](#).

### Configuration Management Database

With the ServiceNow® Configuration Management Database (CMDB) application, build logical representations of assets, services, and the relationships between them that comprise the infrastructure of your organization. Details about these components are stored in the CMDB which you can use to monitor the infrastructure, helping ensure integrity, stability, and continuous service operation.

Use core features such as CMDB Health, CMDB Identification and Reconciliation, and CMDB CI Lifecycle Management to monitor and detect health issues, reconcile data integrity issues, and manage data life cycle.

**Note:** CMDB modules, features, and wizards are not supported on mobile devices. You cannot use a mobile device to access the CI Class Manager, Query Builder, or Duplicate CI Remediator. Or to access or configure CMDB features such as Identification and Reconciliation, CMDB Health, CI Lifecycle Management, baseline CMDB, and proposed changes.
### Configuration Management and the CMDB

The Configuration Management database (CMDB) creates and maintains the logical configurations your network infrastructure needs to support a ServiceNow service.

These logical service configurations are mapped to the physical layout data of the supporting network and application infrastructure in each of your respective domains. They track the physical and logical state of IT service elements and associate incidents to the state of service elements, which helps in analyzing trends and reducing problems and incidents.

The configurations are stored in a configuration management database (ServiceNow CMDB) which consists of entities, called Configuration Items (CI), that are part of your environment. A CI may be:

- A physical entity, such as a computer or router
- A logical entity, such as an instance of a database
- Conceptual, such as a Requisition Service

In each case, there are attributes about the CI that you want to maintain, and there is control you want to have over the CI. There are changes that may need to be made and tracked against the CI. Also, a CI does not exist on its own. CIs have dependencies and relationship with other CIs. For example, the loss of disk drives may take a database instance down, which affects the requisition service that the HR department uses to order equipment for new employees.

It is this relationship data that makes the CMDB a powerful decision support tool. Understanding the dependencies and other relationships among your CIs can tell you, for example, exactly who and what is affected by the loss of that bank of disk drives. When you find out that a router has failed, you will be able to assess the effect of that outage. When you decide to upgrade the processor in a server, you can tell who or what will be affected during the outage.

Configuration items differ from environment to environment because each customer has unique needs. Details about the exact physical attributes of a computer may be needed by one customer, but may represent meaningless data to another. The NOW Platform provides a mechanism to easily define new classes of configuration items and new relationships that may exist between CIs. New classes can be defined that extend other classes. For example, a laptop class exists that extends the computer class. The
computer class itself extends the base CI class. Customer class extensions are automatically part of the ServiceNow environment and blend seamlessly into the integration points for other ITIL processes.

You can for example, set the **Used for** attribute in the cmdb_ci_server table to a value such as ‘development’, ‘test’, or ‘production’. These values indicate the environment that the CI is supporting, and serve as a way of tracking a CI through its lifecycle in a changing environment.

**Architecture**

![Architecture Diagram]

**Roles required**

Reading CMDB tables directly requires the cmdb_read role, however accessing the **Configuration** module requires the asset, itil, or itil_admin roles. For viewing CMDB-related records in the user interface, the itil role is usually sufficient. For updating records and for other manipulation of records, roles with higher credentials are usually required, as noted in each procedure throughout the documentation set.
Domain separation in Configuration Management Database (CMDB)

This is an overview of domain separation and the Configuration Management Database (CMDB). Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Support: Level 2

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

The following topics provide details about domain separation in Configuration Management (CMDB) modules:

- Domain separation in CMDB Health
- Domain separation in CMDB Query Builder
- Domain separation in CMDB Identification and Reconciliation
- Domain separation in the relations formatter and the CI relationship editor
- CMDB APIs (CMDB SDK)

ITIL Configuration Management integration

The CMDB has relationships with IT service management processes in the following areas: ITIL incident management, ITIL problem management, ITIL change management, ITIL service catalog management, and financial management.

ITIL Incident Management

Configuration management assists Incident Management by providing the Service Desk with immediate information on the CIs affected, and more timely resolution of faults by understanding what CIs have been affected and changed.

ITIL Problem Management

Configuration Management assists Problem Management by linking the CIs affected by problems to the Incident / Problem / Change Management processes, and ensuring the CI status is properly maintained.

ITIL Change Management

Configuration Management assists Change Management by recording which CIs have been changed and controlling the status of CIs throughout the entire CI lifecycle. Configuration Management ensures that any changes made to CIs are recorded and kept accurate. Configuration Management is also used in the integration of Change Management with the DiscoverNow Discovery feature.
ITIL Service Catalog Management

With Service Portfolio Management, business services in the CMDB can also be managed by the Service Catalog team, and exposed to end users who can then request items from them.

Financial Management

With Cost Management, costs can be associated with configuration items, so that the cost associated with Configuration Management can be tracked and bundled into expense lines, budgets, or cost centers.

IT4IT

IT4IT provides reference architecture about the implementation of ITIL strategy. For more information, see the ServiceNow Community blog Running IT as a Business using IT4IT and ServiceNow.

ITIL

The IT Infrastructure Library (ITIL) is an integrated, process-based framework for managing IT services. It provides guidance for creating and operating a Service Desk that provides efficient communication between the user community and the IT provider. Originally initiated to improve IT service management for the UK central government, it has become a standard for many organizations; public or private sector, large or small, centralized, or distributed.

ITIL provides processes for three service concepts: design, transition, and operation.

<table>
<thead>
<tr>
<th>Service concept</th>
<th>Processes</th>
</tr>
</thead>
</table>
| Design          | • service level management  
                  • availability management  
                  • capacity management  
                  • supplier management  
                  • service catalog management |
| Transition      | • change management  
                  • knowledge management  
                  • asset management  
                  • configuration management  
                  • release management |
| Operation       | • request fulfillment management  
                  • event management  
                  • incident management  
                  • problem management  
                  • facilities service automation |

Watch this 11-minute video for an overview of the ITIL role including the ITSM process, capabilities of ITIL users, working on incidents and problems, change requests, and the Incident Overview dashboard.

Service design

This guide provides a general overview of ITIL service design concepts.
Service level management

The service level management process is designed to ensure customer satisfaction within IT service processes. Service level agreements are made between the IT staff and the customers, and the IT desk must monitor their performance as compared to the agreements. In addition, underpinning contracts with external vendors and operational level agreements with internal vendors ensures that these service level agreements are feasible.

Availability management

The availability management process ensures that availability within a system is kept as close to 100% as possible. By both reacting to past service failures, and planning to avoid future service failures, availability management can greatly increase end-user satisfaction with services.

Capacity management

The capacity management process is designed to ensure that business services are not made unavailable by over-capacity. By analyzing past failures and planning for growth of demand of services, capacity management can increase end-user satisfaction with services.

Supplier management

Supplier management is a process that defines and monitors agreements between an IT department and an external supplier.

Service catalog management

The service catalog provides a front end for customers to request items and services. Service catalog management ensures that this service catalog provides accurate and useful information on the items and services.

Service transition

This guide provides a general overview of ITIL service transition concepts and how the Now Platform can enable these processes.

Change management

The change management process ensures that standardized methods and procedures are used for efficient and prompt handling of all changes to minimize the impact of change related incidents on service quality. Consequently, change management aims to improve the day-to-day operation of the organization. IT-related changes that may affect one or many customers are tracked with change management. Adding memory to one machine, getting a new server, and installing the latest Windows OS on all PCs are all examples. To find out how the ServiceNow platform implements change management, see Change Management.
Knowledge management

The knowledge management process ensures that important information flows freely throughout the IT organization. Knowledge management keeps the CMDB and knowledge base of an organization up-to-date, and uses a knowledge-centered support approach to reduce repeat incidents and problems. For more information on how the ServiceNow platform implements knowledge management, see Knowledge Management.

Asset management

Asset management enables a process of monitoring processes, organizations, people, information, applications, infrastructure, and financial capital within an organization. This allows the organization to collect accurate records of these business components, making them available for both internal and external auditing processes. To find out how the Now Platform implements asset management, see Asset Management.

Configuration management

Configuration management provides a logical model of the infrastructure or a service by identifying, controlling, maintaining and verifying the Configuration Items in existence. To find out how the Now Platform implements configuration management, see Configuration Management Database.

Release management

This discipline of IT service management is the management of all software configuration items within the organization. It is responsible for the management of software development, installation and support of an organization’s software products. Software Control & Distribution procedures include the management of the software Configuration Items and their distribution and implementation into a production environment. This involves the definition of a release program suitable for the organization, the definition of how version control is implemented, and the procedures surrounding how software is built, released and audited. To find out how the Now Platform implements release management, visit Release Management.

Populate the CMDB

You can populate the CMDB by using Discovery, by importing information from another source, by integrating with an existing external CMDB, or by manually creating CIs.

When you populate the CMDB with information, you create a record for each configuration item in the cmdb_ci table or on one of the tables that extend that table.

ITIL configuration management auto-discovery

The key to any configuration management business practice is the initial and on-going inventory or discovery of what you own. The ServiceNow platform provides three options for auto-discovery:

- The separate and highly robust Discovery product.
- A lightweight native discovery tool, called Help the Help Desk, as part of the overall CMDB. Help the Help Desk enables organizations to proactively scan their network to discover all Windows-based PCs and the software packages installed on those PCs. This WMI-based discovery is included in the core ServiceNow functionality, in the Self Service application, at no additional cost.
• For organizations that want to leverage the discovery technologies they already have deployed (SMS, Tally NetCensus, LanDesk, and so on), the ServiceNow platform supports integrations to those technologies via web services. Scanned data can be mapped directly into the CMDB.

For further information on designing, constructing, and maintaining the CMDB, see white papers CMDB Design & Configuration and CMDB Design.

Discovery

The Discovery product automatically populates the CMDB. Discovery uses probes, sensors, and patterns, to collect and process data about computers, servers, printers, a variety of IP-enabled devices, the applications that run on them, and the relationships between all the items found. This information is sent back to the instance and is used to populate the CMDB.

For more information about Discovery see:
• ITOM Visibility
• Discovery basics

Import information from another source

Information can be imported to the CMDB using import sets. Import sets find files of information (in formats such as XML, Excel, or CSV), import them, and transform them onto the required table. This process can be scheduled or performed on demand.

To import relationships between CIs, use import sets to populate the table [cmdb_rel_ci] with information on the parent, the child, and the nature of the relationship. The [cmdb_rel_ci] table displays a list of all CI relationships and is useful when importing CI data.
Integrate with an existing external CMDB

If the data required for the CMDB is already being collected by another CMDB, it is possible to collect the information from that CMDB in an automated process.
CMDB import integration overview

CMDB instance API

Use the CMDB instance API to populate the CMDB by creating or updating CMDB tables.

Manually create a CI

Create a single CI for a specific class. The role required is based on the selected table settings.

1. Use the CI Class Manager:
   a. Navigate to Configuration > CI Class Manager.
   b. Click Hierarchy to display the list of CI Classes. Select the class to use for the CI.
   c. In the class navigation bar, select CI List and then on the CI list view, click New.
   d. Fill out the CI form and then click Submit.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

162
2. Or, directly use a table:
   a. Navigate to and expand Configuration and then elect the class to use for the CI, such as Business Services.
   b. In the navigation filter of the application navigator, enter the table label (such as 'Linux'), or the table name in the format of <table name>.list (such as 'cmdb_ci_linux_server.list'). Then, press Enter.
   c. In the list view of the table, click New and fill out the form fields for the table.
   d. Click Submit.

CMDB schema model

The Configuration Management Database (CMDB) schema model is a series of connected tables that contain all the assets and business services controlled by a company and its configurations.

CMDB tables contain information about computers and devices on the network, software contracts and licenses, business services, and so on. The IT desk can use the CMDB to better understand their network users' equipment, and the relationships between them. The CMDB can also be referenced by other processes within the system.

The CMDB can be populated using the Discovery product. Discovery searches the network for all attached computers and devices, then populates the CMDB with information on each computer/device's configuration, provisioning, and current status. Discovery also reports on any software which is running, and the TCP connections between computer systems, thereby establishing their relationships.

Applications such as Asset Management and Contract Management, operate in conjunction with the CMDB. Asset Management and Software Asset Management link to CMDB all assets, hardware, software, assets in stock, as well as records for manufacturers and vendors. The Contract Management application contains information about contracts, including leases, service contracts, purchase orders, warranties, and software licenses. The Configuration Management Database (CMDB) application has a focus on operation.

For more background information about the CMDB, see the ServiceNow® Community post) at CMDB 101 - What is a configuration management database and why do you need one?

CMDB tables

Key tables in the configuration management database (CMDB):

- The Base Configuration Item [cmdb] table, which is the core CMDB table for non IT CIs (descending classes are non IT CIs).
- The core Configuration Item [cmdb_ci] table, which stores the basic attributes of all the CIs. The admin, itil, or asset user role is required to access this table (ascending classes are IT CIs).
- The CI Relationship [cmdb_rel_ci] table, which defines all relationships between CIs.

The Configuration Item table is extended to other tables, such as Database [cmdb_ci_database] and Computer [cmdb_ci_computer]. The Computer table is extended to the Server [cmdb_ci_server] table, which is extended to the UNIX Server [cmdb_ci_unix_server] table, and so on.

Note: The Base Configuration Item [cmdb] table uses the table per partition extension model, which has different behaviors for replicating and deriving information than other extended tables. See Table extension and classes.

You can use the schema map to view more details of tables and their relationships:
1. Navigate to **System Definition > Tables & Columns**.

2. Select a table and click **Schema Map**.

   **Note:** CIs not extended from the Configuration Item [cmdb_ci] table, are not displayed in Dependency Views maps and in CI relation formatters.
CI attributes

Attributes apply to all the CIs in a classification. To change attribute values for a CI, edit the appropriate CI. To add a unique attribute to a class, extend the class table and create a new classification for that CI.

The position of a CI in a classification hierarchy is determined by the attributes it shares with the CIs below it. Each time a CI has a single different attribute from its parent, the classification hierarchy branches.

For example, servers have different attributes from computers, which include workstations and laptops. Linux servers and UNIX servers have different attributes from the parent server classification and from each other, so they occupy separate branches in the hierarchy.

CMDB tables descriptions

List of all the tables in the CMDB, and for each table, its name, label, and a description of the type of information that is stored in the table.

<table>
<thead>
<tr>
<th>Table name</th>
<th>Table label</th>
<th>Table description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmdb_ci</td>
<td>Configuration Item</td>
<td>Base configuration item table.</td>
</tr>
<tr>
<td>cmdb_ci_acc</td>
<td>Accessory</td>
<td>Accessories for phones, computers, and so on.</td>
</tr>
<tr>
<td>cmdb_ci_ad_controller</td>
<td>Active Directory Domain Controller</td>
<td>Microsoft Active Directory domain controller.</td>
</tr>
<tr>
<td>cmdb_ci_ad_domain</td>
<td>AD Domain</td>
<td>Microsoft Active Directory domain.</td>
</tr>
<tr>
<td>cmdb_ci_aix_server</td>
<td>AIX Server</td>
<td>Server running the AIX operating system.</td>
</tr>
<tr>
<td>cmdb_ci_alias</td>
<td>Alias</td>
<td>Pseudonym for data locations, virtual email addresses, pointers, and so on.</td>
</tr>
<tr>
<td>cmdb_ci_apache_web_server</td>
<td>Apache Web Server</td>
<td>Server hosting Apache web server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl</td>
<td>Application</td>
<td>Application, which is a collection of files and data that deliver a service and manage business processes.</td>
</tr>
<tr>
<td>cmdb_ci_application_cluster</td>
<td>Application Cluster</td>
<td>Logical group of servers with clustering software installed on each of the servers in the group so that the group acts like a single system.</td>
</tr>
<tr>
<td>cmdb_ci_application_software</td>
<td>Application Software</td>
<td>Computer program, which is designed to perform a group of coordinated functions, tasks, or activities for the benefit of the user.</td>
</tr>
<tr>
<td>cmdb_ci_app_server</td>
<td>Application Server</td>
<td>A base table for logical CIs, which indicate the primary function of a physical or virtual server such as a Tomcat server or a WebSphere server.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_composer</td>
<td>Composer</td>
<td>Server hosting IBM WebSphere Multichannel Bank Transformation Toolkit.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_app_server_datapower</td>
<td>Data Power</td>
<td>Server hosting IBM DataPower Gateway Secure software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_domino</td>
<td>Domino</td>
<td>Server hosting IBM Domino software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_hp_ucmdb</td>
<td>HP uCMDB</td>
<td>Server hosting HP uCMDB software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_java</td>
<td>JavaServer</td>
<td>Server hosting Java application.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_jb_module</td>
<td>delivery Controler</td>
<td>Server hosting inner module of JBoss application (deployed application).</td>
</tr>
<tr>
<td>cmdb_ci_app_server_jboss</td>
<td>JBoss</td>
<td>Server hosting JBoss Application Server (JBoss AS), which is a cross-platform Java application server, open-source developed by JBoss software company.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_jrun</td>
<td>Jrun</td>
<td>Server hosting JRun application.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_jrun_war</td>
<td>Jrun WAR</td>
<td>Server hosting the inner module of JRun application (deployed application).</td>
</tr>
<tr>
<td>cmdb_ci_app_server_ora_ess</td>
<td>Oracle Essbase Server</td>
<td>Server hosting Oracle Essbase software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_ora_IAS</td>
<td>Oracle iAS</td>
<td>Server hosting Oracle Internet Application Server.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_ora_ias_m</td>
<td>Oracle iAS Web module</td>
<td>Server hosting the inner module of Oracle iAS application (deployed application).</td>
</tr>
<tr>
<td>cmdb_ci_app_server_remedy</td>
<td>Remedy HSServer</td>
<td>Server hosting Remedy HSServer application.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_tomcat</td>
<td>Tomcat</td>
<td>Server hosting Apache Tomcat software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_tomcat_war</td>
<td>Tomcat WAR</td>
<td>Server hosting inner module of Apache Tomcat application (deployed application).</td>
</tr>
<tr>
<td>cmdb_ci_app_server_vendavo</td>
<td>Vendavo Application Server</td>
<td>Server hosting Vendavo Application Server software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_weblogic</td>
<td>BEA Weblogic</td>
<td>Server hosting Oracle WebLogic Server.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_webseal</td>
<td>Webseal</td>
<td>Server hosting IBM Tivoli Access Manager solution.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_websphere</td>
<td>IBM Websphere</td>
<td>Server hosting IBM WebSphere software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_wl_module</td>
<td>WeblogicModule</td>
<td>Server hosting inner module of Tomcat.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_ws_ear</td>
<td>Websphere EAR</td>
<td>Server hosting inner module of IBM WebSphere software.</td>
</tr>
<tr>
<td>cmdb_ci_app_server_ws_odr</td>
<td>Websphere ODR LB</td>
<td>Server hosting WebSphere ODR LB application.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_appl_active_directory</td>
<td>Active Directory Service</td>
<td>Inner software module of AD Domain application.</td>
</tr>
<tr>
<td>cmdb_ci_appl_biztalk</td>
<td>BizTalk</td>
<td>Microsoft BizTalk Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_biztalk_orch</td>
<td>BizTalk Orchestration</td>
<td>Inner module of Microsoft Biztalk Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ca</td>
<td>CA Enterprise Communicator</td>
<td>CA Enterprise Communicator software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ca_ent_man</td>
<td>CA Introscope Enterprise Manager</td>
<td>CA introscope Enterprise Manager software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ca_id_man</td>
<td>CA Identity Manager Provisioning Server</td>
<td>CA Identity Manager Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_cisco_call_man</td>
<td>Cisco CallManager</td>
<td>Cisco CallManager (Cisco Unified Communications Manager) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_cisco_fibre</td>
<td>Cisco Fibre InterConnect</td>
<td>Cisco Fibre InterConnect software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_citrix_app</td>
<td>Citrix Application Icon</td>
<td>Inner module of Citrix software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_citrix_collector</td>
<td>Citrix Collector</td>
<td>Citrix Collector software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_citrix_xenapp</td>
<td>Citrix XenAPP or Presentation Server</td>
<td>Citrix XenApp software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_connectit</td>
<td>Connect-It Service</td>
<td>Connect-It software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_controlm</td>
<td>Control-M</td>
<td>Control-M software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_delivery_controller</td>
<td>Delivery Controler</td>
<td>Application delivery controller software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_doc_brava_proc</td>
<td>Documentum Brava Job Processor</td>
<td>Brava (EMC Documentum) job processor software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_doc_brava_server</td>
<td>Documentum Brava License Server</td>
<td>Brava (EMC Documentum) License Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_doc_docbase</td>
<td>Documentum DocBase</td>
<td>Documentum Docbase software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_doc_docbroker</td>
<td>Documentum Broker</td>
<td>Documentum Docbase broker software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_dot_net</td>
<td>.NET Application</td>
<td>Microsoft .NET application software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_fastsearch</td>
<td>Fast Search</td>
<td>Microsoft FAST Search software (for the SharePoint collaboration platform).</td>
</tr>
<tr>
<td>cmdb_ci_appl_generic</td>
<td>Generic Application</td>
<td>Generic application, which is identified by the system when there is an endpoint with an open port in listen mode and there is no pattern for it.</td>
</tr>
<tr>
<td>cmdb_ci_appl_glassfish</td>
<td>GlassFish</td>
<td>Oracle GlassFish Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_glassfish_war</td>
<td>GlassFish WAR</td>
<td>Inner module of GlassFish application (deployed application).</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_appl_groundwork</td>
<td>Groundwork</td>
<td>Groundwork (open source) monitoring software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_hp_index</td>
<td>HP SM Index Server</td>
<td>HP Service Manager Index Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_hp_operations</td>
<td>HP Operations Manager</td>
<td>HP Operations Manager software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_hp_qc</td>
<td>HP Quality Center</td>
<td>HP Quality Center software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_hp_service</td>
<td>HP Service Manager</td>
<td>HP Service Manager software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_hp_sm_kb</td>
<td>HP SM KnowledgeBase</td>
<td>HP Service Manager KnowledgeBase software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ibm_cics</td>
<td>IBM CICS</td>
<td>IBM CICS Transaction Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ibm_ctg</td>
<td>IBM CTG</td>
<td>IBM CICS Transaction Gateway software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ibm_wmb</td>
<td>IBM WebSphere Message Broker</td>
<td>IBM WebSphere Message Broker software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ibm_wmb_listener</td>
<td>IBM WMB Http Listener</td>
<td>IBM WebSphere HTTP Listener software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ibm_wmq</td>
<td>IBM WebSphere MQ</td>
<td>IBM Websphere MQ software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ibm_wmq_queue</td>
<td>IBM WebSphere MQ Queue</td>
<td>Inner module of IBM WebSphere MQ software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_itam</td>
<td>ITAM Asset Center</td>
<td>HP Asset Center software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_mongo_config_serv</td>
<td>Mongo Config Server</td>
<td>Mongo Configuration Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_mongos</td>
<td>Mongos Server</td>
<td>MongoDB server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ms_dynamic_crm</td>
<td>Dynamic CRM Component</td>
<td>Microsoft Dynamic CRM software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_msmq</td>
<td>MSMQ</td>
<td>Microsoft Message Queuing (MSMQ) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_conc</td>
<td>Oracle Concurrent Server</td>
<td>Oracle Concurrent Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_disc</td>
<td>Oracle Discoverer Engine</td>
<td>Oracle Discoverer software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_disc_ui</td>
<td>Oracle Discoverer UI</td>
<td>Oracle Discoverer UI module software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_ebs</td>
<td>Oracle ESB</td>
<td>Oracle Enterprise Service Bus software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_forms</td>
<td>Oracle Forms Engine</td>
<td>Oracle Forms software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_forms_ui</td>
<td>Oracle Forms UI</td>
<td>Oracle Forms UI software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_fs</td>
<td>Oracle Fulfillment Server</td>
<td>Oracle Fulfillment Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_http</td>
<td>Oracle HTTP Server</td>
<td>Oracle HTTP Server software (web tier of Oracle Fusion middleware).</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_jms_queue</td>
<td>Oracle Weblogic JMS Queue</td>
<td>Oracle WebLogic JMS software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_metric_client</td>
<td>Oracle Metric Client</td>
<td>Oracle Metric client software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_metric_svr</td>
<td>Oracle Metric Server</td>
<td>Oracle Metric server software.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>----------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_notif_svr</td>
<td>Oracle Notification Server</td>
<td>Oracle Notification Server (ONS) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_oacore</td>
<td>Oracle OACORE Server</td>
<td>Oracle OACORE server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_oafm</td>
<td>Oracle OAFM Server</td>
<td>Oracle OAFM server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_pm</td>
<td>Oracle Process Manager</td>
<td>Oracle BPEL Process Manager server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_queue</td>
<td>Advanced Queue Queue</td>
<td>Oracle Advanced Queuing software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_tns</td>
<td>Oracle App TNS Service</td>
<td>Oracle Application Express (TNS) listener software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_ora_tnslsr</td>
<td>Oracle TNS Listener Engine</td>
<td>Oracle Application Express software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_peoplesoft</td>
<td>Peoplesoft Application Server</td>
<td>Peoplesoft Application Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_rabbitmq</td>
<td>RabbitMQ</td>
<td>RabbitMQ (open source) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_rabbitmq_cluster</td>
<td>RabbitMQ Cluster</td>
<td>RabbitMQ Cluster (open source) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_ascs</td>
<td>SAP ASCS Application</td>
<td>SAP ASCS software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_bo_scheduler</td>
<td>SAP BO BOXIScheduleRouter</td>
<td>SAP BO BOXIScheduleRouter software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_bus_obj</td>
<td>SAP Business Objects</td>
<td>SAP business Object application.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_ci</td>
<td>SAP CI Application</td>
<td>The SAP Central Instance software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_di</td>
<td>SAP DI Application</td>
<td>Oracle Development Infrastructure (DI) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_ers</td>
<td>SAP ERS Application</td>
<td>Oracle Evaluated Receipt Settlement (ERS) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_hana_db</td>
<td>SAP Hana Db</td>
<td>SAP HANA software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap jc</td>
<td>SAP JC Application</td>
<td>SAP JC (java application) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_scs</td>
<td>SAP SCS Application</td>
<td>SAP SCS (central services) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_server</td>
<td>SAP Application Server</td>
<td>SAP NetWeaver Application Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sap_system</td>
<td>SAP System</td>
<td>SAP ERP software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sendmail</td>
<td>Sendmail</td>
<td>Sendmail (open source) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sharepoint</td>
<td>SharePoint</td>
<td>Microsoft SharePoint software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_sp_service</td>
<td>SharePoint Service</td>
<td>Microsoft Windows Sharepoint Services (WSS) software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_tibco_hawk</td>
<td>Tibco Hawk</td>
<td>TIBCO Hawk software.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_appl_tibco_message</td>
<td>Tibco Enterprise Message Service</td>
<td>TIBCO Enterprise Message Service software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_tibco_queue</td>
<td>EMS Queue</td>
<td>Tibco EMS (Enterprise Message Service) Queues software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_tuxedo</td>
<td>Tuxedo</td>
<td>Tuxedo software (middleware transactions for Unix, Extended for Distributed Operations).</td>
</tr>
<tr>
<td>cmdb_ci_appl_tuxedo_portal</td>
<td>Tuxedo Portal</td>
<td>Tuxedo portal software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_vign_content_svr</td>
<td>Vignette Content Management Server</td>
<td>Vignette (Open Text Corp) Content Management Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_vignette_search</td>
<td>Vignette Search Starter</td>
<td>Vignette (Open Text Corp) Search Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_vignette_server</td>
<td>Vignette Server</td>
<td>Vignette (Open Text Corp) Server software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_weblogic_jms</td>
<td>Weblogic JMS Server</td>
<td>WebLogic JMS software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_weblogic_lb</td>
<td>Weblogic LB</td>
<td>WebLogic Server load balancer software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_weblogicmodule</td>
<td>Weblogic Module Server</td>
<td>WebLogicServer software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_websphere_portal</td>
<td>Websphere Portal</td>
<td>WebSphere Portal software.</td>
</tr>
<tr>
<td>cmdb_ci_appl_wmb</td>
<td>WMB Flow</td>
<td>WebSphere Message Broker software.</td>
</tr>
<tr>
<td>cmdb_ci_application_cluster</td>
<td>Application Cluster</td>
<td>Logical cluster of application-tier servers.</td>
</tr>
<tr>
<td>cmdb_ci_application_software</td>
<td>Application Software</td>
<td>Computer program designed to perform a group of coordinated functions, tasks, or activities for the benefit of the user.</td>
</tr>
<tr>
<td>cmdb_ci_application_software</td>
<td>Application Software</td>
<td>An extension of the Software table, providing installed software information (not a running process).</td>
</tr>
<tr>
<td>cmdb_ci_ats_power_eq</td>
<td>Automatic Transfer Switch</td>
<td>Electrical power switch that switches a load between two sources.</td>
</tr>
<tr>
<td>cmdb_ci_availability_set</td>
<td>Availability Set</td>
<td>Logical grouping of virtual machines running on Microsoft Azure platform.</td>
</tr>
<tr>
<td>cmdb_ci_batch_job</td>
<td>Batch Job</td>
<td>A computer program or set of programs processed in batch mode.</td>
</tr>
<tr>
<td>cmdb_ci_aws_datacenter</td>
<td>AWS datacenter</td>
<td>Logical representation of an Amazon Web Services datacenter.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmbd_ci_azure_datacenner</td>
<td>Azure datacener</td>
<td>Logical representation of a Microsoft Azure datacenter.</td>
</tr>
<tr>
<td>cmbd_ci_business_process</td>
<td>Business Process</td>
<td>A process that is owned and carried out by the business and contributes to the delivery of a product or business service to a business customer.</td>
</tr>
<tr>
<td>cmbd_ci_chassis_server</td>
<td>Server Chassis</td>
<td>A metal structure that is used to house or physically assemble servers in various different form factors.</td>
</tr>
<tr>
<td>cmbd_ci_cim_profile</td>
<td>CIM Profiles</td>
<td>CIM Profiles (UML).</td>
</tr>
<tr>
<td>cmbd_ci_cim_server</td>
<td>CIM Server</td>
<td>Server hosting CIM profiles.</td>
</tr>
<tr>
<td>cmbd_ci_circuit</td>
<td>Circuit</td>
<td>Electrical circuits information.</td>
</tr>
<tr>
<td>cmbd_ci_cloud_database</td>
<td>Cloud Database</td>
<td>Database which runs on a cloud computing platform.</td>
</tr>
<tr>
<td>cmbd_ci_cloud_ip_address</td>
<td>Cloud IP Address</td>
<td>Web server which runs on a cloud computing platform.</td>
</tr>
<tr>
<td>cmbd_ci_cluster</td>
<td>Cluster</td>
<td>Logical group of computing resources bound together by software in order to function as one logical computing resource.</td>
</tr>
<tr>
<td>cmbd_ci_cluster_node</td>
<td>Cluster Node</td>
<td>Single computing resource which is logically/operationally bound into a cluster.</td>
</tr>
<tr>
<td>cmbd_ci_cluster_resource</td>
<td>Cluster Resource</td>
<td>System object that is a set or grouping of cluster resources that are used to manage events that occur in a clustered environment.</td>
</tr>
<tr>
<td>cmbd_ci_cluster_vip</td>
<td>Cluster Virtual IP</td>
<td>Cluster VIP information.</td>
</tr>
<tr>
<td>cmbd_ci_comm</td>
<td>Communication Device</td>
<td>Communication devices information. A choice list containing devices such as cellphone, phone, conference phone, and Wi-Fi.</td>
</tr>
<tr>
<td>cmbd_ci_computer</td>
<td>Computer</td>
<td>An extension of the Hardware table, capturing computer properties.</td>
</tr>
<tr>
<td>cmbd_ci_computer_room</td>
<td>Computer Room</td>
<td>Logical representation of a computer room.</td>
</tr>
<tr>
<td>cmbd_ci_config_file</td>
<td>Configuration file</td>
<td>Configuration files which establish the parameters and initial settings for some computer programs.</td>
</tr>
<tr>
<td>cmbd_ci_crac</td>
<td>Computer Room AC</td>
<td>Air conditioning units used to cool data centers.</td>
</tr>
<tr>
<td>cmbd_ci_csu_dsu_network</td>
<td>CSU/DSU</td>
<td>Digital-interface device used to connect networking equipment to a digital circuit.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_database</td>
<td>Database</td>
<td>Organized collection of data such as the set of files where data is stored, the reason for a database, and the metadata about the data.</td>
</tr>
<tr>
<td>cmdb_ci_datacenter</td>
<td>Data Center</td>
<td>Facility used to house computer systems and associated components, such as telecommunications and storage systems. It generally includes redundant or backup power supplies, redundant data communications connections, environmental controls (such as air conditioning and fire suppression), and various security devices.</td>
</tr>
<tr>
<td>cmdb_ci_datapower_server</td>
<td>Data Power Hosting Server</td>
<td>Server running IBM DataPower Gateway software.</td>
</tr>
<tr>
<td>cmdb_ci_db_catalog</td>
<td>Database Catalog</td>
<td>Metadata which defines database objects such as base tables, views (virtual tables), synonyms, value ranges, indexes, users, and user groups, for a specific database instance.</td>
</tr>
<tr>
<td>cmdb_ci_db_db2_catalog</td>
<td>DB2 Catalog</td>
<td>Database catalog for DB2 database.</td>
</tr>
<tr>
<td>cmdb_ci_db_db2_instance</td>
<td>DB2 Instance</td>
<td>Instance of a DB2 database.</td>
</tr>
<tr>
<td>cmdb_ci_db_hbase_instance</td>
<td>HBase Instance</td>
<td>Instance of an HBase database.</td>
</tr>
<tr>
<td>cmdb_ci_db_instance</td>
<td>Database Instance</td>
<td>Software and memory used to manipulate data in a database.</td>
</tr>
<tr>
<td>cmdb_ci_db_mongodb_instance</td>
<td>MongoDB Instance</td>
<td>Instance of a MongoDB database.</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_analysis</td>
<td>SQL Server Analysis Services</td>
<td>MSFT SQL Catalog</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_catalog</td>
<td>MSFT SQL Catalog</td>
<td>Database catalog for a specific instance of a Microsoft SQL database.</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_int_job</td>
<td>SQL Server Integration Services Job</td>
<td>Scheduled job to run a SQL Server Integration Service package.</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_integration</td>
<td>SQL Server Integration Services</td>
<td>MSQl Server Integration Services software.</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_reporting</td>
<td>SQL Server Reporting Services</td>
<td>SQL Server software used for server-based reporting generation.</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_server</td>
<td>MS SQL Server</td>
<td>Microsoft SQL Server.</td>
</tr>
<tr>
<td>cmdb_ci_db_mysql_catalog</td>
<td>MySQL Catalog</td>
<td>Database catalog for a specific instance of a MySQL database.</td>
</tr>
<tr>
<td>cmdb_ci_db_mysql_clustermgnode</td>
<td>MySQLClusterMGMNode</td>
<td>MySQL primary administrative interface to a running cluster.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_db_mysql_clusternode</td>
<td>MySQLClusterDataNode</td>
<td>Summary table used in the [ndbd] or [ndbd default] sections of a config.ini file for configuring MySQL Cluster data nodes.</td>
</tr>
<tr>
<td>cmdb_ci_db_mysql_instance</td>
<td>MySQL Instance</td>
<td>Instance of a MySQL database.</td>
</tr>
<tr>
<td>cmdb_ci_db_ora_catalog</td>
<td>Oracle Catalog</td>
<td>Database catalog for a specific instance of an Oracle database.</td>
</tr>
<tr>
<td>cmdb_ci_db_ora_instance</td>
<td>Oracle Instance</td>
<td>Instance of an Oracle database.</td>
</tr>
<tr>
<td>cmdb_ci_db_ora_listener</td>
<td>Oracle Database Listener</td>
<td>Process that runs on an Oracle Database Server.</td>
</tr>
<tr>
<td>cmdb_ci_db_postgresql_instance</td>
<td>PostgreSQL Instance</td>
<td>Instance of a PostgreSQL database.</td>
</tr>
<tr>
<td>cmdb_ci_db_syb_catalog</td>
<td>Sybase Catalog</td>
<td>Database catalog for a specific instance of a Sybase database.</td>
</tr>
<tr>
<td>cmdb_ci_db_syb_instance</td>
<td>Sybase Instance</td>
<td>Instance of a Sybase database.</td>
</tr>
<tr>
<td>cmdb_ci_desktop_software</td>
<td>Desktop Software</td>
<td>Software used on desktops and laptops.</td>
</tr>
<tr>
<td>cmdb_ci_dir_policy_server</td>
<td>Policy Server</td>
<td>Policy server, which provides a security component of a policy-based network that provides authorization services and facilitates tracking and control of files.</td>
</tr>
<tr>
<td>cmdb_ci_dir_site_minder_server</td>
<td>Site Minder</td>
<td>Server running SiteMinder software.</td>
</tr>
<tr>
<td>cmdb_ci_directory_ad_forest</td>
<td>AD Forest</td>
<td>Active Directory forest.</td>
</tr>
<tr>
<td>cmdb_ci_directory_ha</td>
<td>HA Proxy</td>
<td>HAProxy software.</td>
</tr>
<tr>
<td>cmdb_ci_directory_iifp</td>
<td>IIFP</td>
<td>Identity Identification Feature Pack (Active Directory) software.</td>
</tr>
<tr>
<td>cmdb_ci_directory_server</td>
<td>Directory Server</td>
<td>Server running LDAP software.</td>
</tr>
<tr>
<td>cmdb_ci_disk</td>
<td>Disk</td>
<td>General category of data storage mechanisms.</td>
</tr>
<tr>
<td>cmdb_ci_disk_partition</td>
<td>Disk Partition</td>
<td>Sections of a disk separated so that information in each section can be managed separately.</td>
</tr>
<tr>
<td>cmdb_ci_display_hardware</td>
<td>Display Hardware</td>
<td>Hardware used to display information in visual form.</td>
</tr>
<tr>
<td>cmdb_ci_dns_alias</td>
<td>DNS Alias</td>
<td>Synonym for the host used to resolve DNS addresses.</td>
</tr>
<tr>
<td>cmdb_ci_dns_name</td>
<td>DNS Name</td>
<td>Primary DNS names.</td>
</tr>
<tr>
<td>cmdb_ci_docker</td>
<td>Docker Container</td>
<td>Docker containers (a runtime instance of a docker image).</td>
</tr>
<tr>
<td>cmdb_ci_docker_engine</td>
<td>Docker Engine</td>
<td>Docker software for running and managing Docker containers.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_docker_image</td>
<td>Docker Image</td>
<td>Docker images. Ordered collection of root filesystem changes and the corresponding execution parameters for use within a container runtime.</td>
</tr>
<tr>
<td>cmdb_ci_docker_image_tag</td>
<td>Docker Image Tag</td>
<td>Docker tag, which is a label applied to a Docker image in a repository.</td>
</tr>
<tr>
<td>cmdb_ci_docker_local_image</td>
<td>Docker Local Image</td>
<td>Locally managed Docker image.</td>
</tr>
<tr>
<td>cmdb_ci_drs_vm_config</td>
<td>DRS VM Config</td>
<td>Distributed Resource Scheduler (DRS) behavior for the VMs in the vCenter that override the cluster behavior.</td>
</tr>
<tr>
<td>cmdb_ci_ec2_instance</td>
<td>EC2 Virtual Machine Instance</td>
<td>Virtual machine running in the Amazon Elastic Compute Cloud (EC2) platform.</td>
</tr>
<tr>
<td>cmdb_ci_email_server</td>
<td>Email Server</td>
<td>Server running email software.</td>
</tr>
<tr>
<td>cmdb_ci_email_server_jes</td>
<td>JES</td>
<td>Server running JES software (multi-featured hybrid MTA/MDA server).</td>
</tr>
<tr>
<td>cmdb_ci_endpoint</td>
<td>Endpoint</td>
<td>Endpoint, which represents the entry point to a service, a process, or a queue or topic destination in service-oriented architecture.</td>
</tr>
<tr>
<td>cmdb_ci_environment</td>
<td>Environment</td>
<td>Logical grouping of hardware and software used to develop, test, and deliver computing services. For example: development, test, quality assurance, and production.</td>
</tr>
<tr>
<td>cmdb_ci_esx_resource_pool</td>
<td>ESX Resource Pool</td>
<td>VMware set of physical resources.</td>
</tr>
<tr>
<td>cmdb_ci_esx_server</td>
<td>ESX Server</td>
<td>Physical ESX server running the VMware ESXi operating system.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_cas</td>
<td>Exchange Client Access Server</td>
<td>Server running Exchange software providing client access services.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_edge_transport</td>
<td>Exchange Edge Transport Server</td>
<td>Server running Exchange Edge Transport software.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_hub</td>
<td>ExchangeHub</td>
<td>Server running Exchange Hub software.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_hub_transport</td>
<td>Exchange Hub Transport Server</td>
<td>Server running Exchange Hub software providing transport services.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_mailbox</td>
<td>Exchange MailBox</td>
<td>Exchange email account.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_mailbox_server</td>
<td>Exchange Mailbox Server</td>
<td>Server running Exchange software providing client access services.</td>
</tr>
<tr>
<td>cmdb_ci_exchange_service_component</td>
<td>Exchange Service Component</td>
<td>Server running Exchange software.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_facility_hardware</td>
<td>Facility Hardware</td>
<td>Base class for hardware used to facilities services such as electric, water, sewer, air, and security.</td>
</tr>
<tr>
<td>cmdb_ci_fc_disk</td>
<td>Fibre Channel Disk</td>
<td>Base table for fibre channel disk.</td>
</tr>
<tr>
<td>cmdb_ci_fc_export</td>
<td>Fibre Channel Export</td>
<td>Storage volume exported by a storage server via Fibre Channel protocol.</td>
</tr>
<tr>
<td>cmdb_ci_fc_port</td>
<td>Fibre Channel Port</td>
<td>Fibre Channel port on a storage server, FC switch, or on a host's HBA.</td>
</tr>
<tr>
<td>cmdb_ci_fddi_network</td>
<td>FDDI Cards</td>
<td>Fiber Distributed Data Interface cards.</td>
</tr>
<tr>
<td>cmdb_ci_file_system</td>
<td>File System</td>
<td>File system information for a server, capturing details such as mount point, capacity, and type of file system.</td>
</tr>
<tr>
<td>cmdb_ci_file_system_nfs</td>
<td>NFS File system</td>
<td>Extension of File System, which provides NFS file system information.</td>
</tr>
<tr>
<td>cmdb_ci_file_system_smb</td>
<td>SMB File system</td>
<td>Extension of File System, which provides SMB file system information.</td>
</tr>
<tr>
<td>cmdb_ci_firewall_network</td>
<td>Firewall Hardware</td>
<td>Firewall hardware.</td>
</tr>
<tr>
<td>cmdb_ci_ftp_server</td>
<td>FTP Server</td>
<td>Server providing FTP services.</td>
</tr>
<tr>
<td>cmdb_ci_fuel_tank</td>
<td>Fuel Tank</td>
<td>Fuel tank.</td>
</tr>
<tr>
<td>cmdb_ci_generator_power_eq</td>
<td>Power Generator</td>
<td>Power generator.</td>
</tr>
<tr>
<td>cmdb_ci_group</td>
<td>Group</td>
<td>Logical group of CIs.</td>
</tr>
<tr>
<td>cmdb_ci_hardware</td>
<td>Hardware</td>
<td>Base class for hardware.</td>
</tr>
<tr>
<td>cmdb_ci_hpux_server</td>
<td>HPUX Server</td>
<td>Server running HPUX software.</td>
</tr>
<tr>
<td>cmdb_ci_hub_network</td>
<td>Hub Hardware</td>
<td>Physical network hub.</td>
</tr>
<tr>
<td>cmdb_ci_hvac</td>
<td>HVAC Equipment</td>
<td>Heating, ventilation, and air conditioning equipment.</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_cluster</td>
<td>Hyper-V Cluster</td>
<td>Cluster of the Hyper-V servers.</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_instance</td>
<td>Hyper-V Virtual Machine Instance</td>
<td>Hyper-V virtual machine instance. This table extends the generic Virtual Machine Instance [cmdb_ci_vm_instance] table.</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_network</td>
<td>Hyper-V Virtual Network</td>
<td>Hyper-V virtual network.</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_object</td>
<td>Hyper-V Object</td>
<td>Base class for all Hyper-V objects.</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_resource_pool</td>
<td>Hyper-V Resource Pool</td>
<td>Hyper-V resource pool.</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_rpool_comp</td>
<td>Hyper-V Resource Pool Component</td>
<td>Resource pool component belonging to resource pool.</td>
</tr>
<tr>
<td>cmdb_ci_hyper_v_server</td>
<td>Hyper-V Server</td>
<td>Server running Hyper-V software.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_ids_network</td>
<td>Intrusion Detection System</td>
<td>Security intrusion detection systems.</td>
</tr>
<tr>
<td>cmdb_ci_iisdirectory</td>
<td>IIS Virtual Directory</td>
<td>Virtual Directory in IIS Manager.</td>
</tr>
<tr>
<td>cmdb_ci_imaging_hardware</td>
<td>Imaging Hardware</td>
<td>Hardware used to create electronic/physical images.</td>
</tr>
<tr>
<td>cmdb_ci_inetinfo</td>
<td>Inetinfo service</td>
<td>Inetinfo service of IIS application.</td>
</tr>
<tr>
<td>cmdb_ci_inf_software</td>
<td>Infrastructure Software</td>
<td>Base class for enterprise software or programs specifically designed to help business organizations perform basic tasks such as workforce support, business transactions and internal services, and processes.</td>
</tr>
<tr>
<td>cmdb_ci_information_object</td>
<td>Information Object</td>
<td>Types of information that a business application or any other entity handles. For example: 'Employee Salary Data', 'Employee Personal Data', and 'Sales Data'.</td>
</tr>
<tr>
<td>cmdb_ci_infra_service</td>
<td>Infrastructure Service</td>
<td>IT services which support providing computing infrastructure.</td>
</tr>
<tr>
<td>cmdb_ci_infra_service_ldap</td>
<td>LDAP Service</td>
<td>Running LDAP service.</td>
</tr>
<tr>
<td>cmdb_ci_ip_address</td>
<td>IP Address</td>
<td>IP address.</td>
</tr>
<tr>
<td>cmdb_ci_ip_device</td>
<td>IP Device</td>
<td>Base class for devices with an IP address.</td>
</tr>
<tr>
<td>cmdb_ci_ip_firewall</td>
<td>IP Firewall</td>
<td>Firewall hardware.</td>
</tr>
<tr>
<td>cmdb_ci_ip_network</td>
<td>IP Network</td>
<td>IP network information capturing details such as subnet, router, and router_interface_type.</td>
</tr>
<tr>
<td>cmdb_ci_ip_phone</td>
<td>IP Phone</td>
<td>IP-enabled (VOIP) phone.</td>
</tr>
<tr>
<td>cmdb_ci_ip_router</td>
<td>IP Router</td>
<td>Specialization of the Network Gear [cmdb_ci_netgear] table.</td>
</tr>
<tr>
<td>cmdb_ci_ip_server</td>
<td>IP Server</td>
<td>Server hardware.</td>
</tr>
<tr>
<td>cmdb_ci_ip_service</td>
<td>IP Service Instance</td>
<td>Base table for IP services running on a server such Unix daemon or Windows service.</td>
</tr>
<tr>
<td>cmdb_ci_ip_switch</td>
<td>IP Switch</td>
<td>Specialization of the Network Gear [cmdb_ci_netgear] table.</td>
</tr>
<tr>
<td>cmdb_ci_iplanet_web_server</td>
<td>Iplanet Web Server</td>
<td>Server running Oracle iPlanet Web Server (OiWS) software.</td>
</tr>
<tr>
<td>cmdb_ci_isam_server</td>
<td>ISAM Server</td>
<td>Server running ISAM software.</td>
</tr>
<tr>
<td>cmdb_ci_iscsi_disk</td>
<td>iSCSI Disk</td>
<td>Host mount of an iSCSI disk.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_iscsi_export</td>
<td>iSCSI Export</td>
<td>Storage volume exported by a storage server via iSCSI.</td>
</tr>
<tr>
<td>cmdb_ci_kvm</td>
<td>KVM</td>
<td>Hypervisor that manages kernel-based virtual machines (KVMs).</td>
</tr>
<tr>
<td>cmdb_ci_kvm_network</td>
<td>Network</td>
<td>KVM Virtual network.</td>
</tr>
<tr>
<td>cmdb_ci_kvm_object</td>
<td>KVM Object</td>
<td>Base object for all KVM objects.</td>
</tr>
<tr>
<td>cmdb_ci_kvm_storage_pool</td>
<td>Storage Pool</td>
<td>KVM storage pool.</td>
</tr>
<tr>
<td>cmdb_ci_kvm_storage_volume</td>
<td>Storage Volume</td>
<td>KVM storage volume.</td>
</tr>
<tr>
<td>cmdb_ci_kvm_vm_instance</td>
<td>KVM Virtual Machine Instance</td>
<td>Virtual machine instance running on a KVM hypervisor.</td>
</tr>
<tr>
<td>cmdb_ci_lb</td>
<td>Load Balancer</td>
<td>Server functioning as a load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_a10</td>
<td>A10 Load Balancer</td>
<td>Server functioning as an A10 load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_ace</td>
<td>ACE</td>
<td>Server functioning as an ACE load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_alteon</td>
<td>Alteon</td>
<td>Server functioning as an Alteon load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_appl</td>
<td>Load Balancer Application</td>
<td>Application that provides load balancing functionality.</td>
</tr>
<tr>
<td>cmdb_ci_lb_backend_server</td>
<td>LB Backend Server</td>
<td>Server functioning as a backend load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_bigip</td>
<td>F5 BIG-IP</td>
<td>Server functioning as an F5 BIG-IP load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_cisco_csm</td>
<td>Cisco CSM</td>
<td>Server functioning as a Cisco CSM load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_cisco_css</td>
<td>Cisco CSS</td>
<td>Server functioning as a Cisco CSS load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_f5_gtm</td>
<td>F5 BigIP GTM</td>
<td>Server functioning as an F5 BigIP GTM load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_f5_ltm</td>
<td>F5 BigIP LTM</td>
<td>A server functioning as an F5 BigIP LTM load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_haproxy</td>
<td>HAProxy Load Balancer</td>
<td>Server functioning as an HA Proxy load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_isa</td>
<td>ISA Server</td>
<td>Server functioning as an ISA load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_modjk</td>
<td>Modjk Load Balancer</td>
<td>Server functioning as a Cisco CSM load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_modproxy</td>
<td>ModProxy Load Balancer</td>
<td>Server functioning as a ModProxy load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_netscaler</td>
<td>Citrix Netscaler</td>
<td>Server functioning as a Citrix Netscaler load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_network</td>
<td>Network Load Balancer</td>
<td>Server performing network load balancing.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_lb_nginx</td>
<td>Nginx Load Balancer</td>
<td>Server functioning as an Nginx load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_pool</td>
<td>Load Balancer Pool</td>
<td>Collection of host-to-port mappings to be balanced.</td>
</tr>
<tr>
<td>cmdb_ci_lb_pool_member</td>
<td>Load Balancer Pool Member</td>
<td>Host-to-port mapping of a request to be balanced.</td>
</tr>
<tr>
<td>cmdb_ci_lb_radware</td>
<td>Radware Load Balancer</td>
<td>Server functioning as a Radware load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_service</td>
<td>Load Balancer Service</td>
<td>Virtual service that the device balances by forwarding requests to members within a pool.</td>
</tr>
<tr>
<td>cmdb_ci_lb_template</td>
<td>Load Balancer Template</td>
<td>Load balancer template which contains load balancer-related configuration settings for a specific type of network traffic.</td>
</tr>
<tr>
<td>cmdb_ci_lif</td>
<td>LIF</td>
<td>Logical interface.</td>
</tr>
<tr>
<td>cmdb_ci_lb_vlan</td>
<td>Load Balancer VLAN</td>
<td>Virtual LAN segment.</td>
</tr>
<tr>
<td>cmdb_ci_linux_server</td>
<td>Linux Server</td>
<td>Server running Linux software.</td>
</tr>
<tr>
<td>cmdb_ci_logical_datacenter</td>
<td>Logical Datacenter</td>
<td>VMware vCenter logical datacenter.</td>
</tr>
<tr>
<td>cmdb_ci_lpar</td>
<td>Logical Partition</td>
<td>Logical partition, commonly called an LPAR, is a subset of a computer’s hardware resources, virtualized as a separate computer.</td>
</tr>
<tr>
<td>cmdb_ci_lvm_pool</td>
<td>LVM Pool</td>
<td>Linux Volume Manager storage pool.</td>
</tr>
<tr>
<td>cmdb_ci_lvm_pool_member</td>
<td>LVM Pool Member</td>
<td>Linux Volume Manager storage pool member.</td>
</tr>
<tr>
<td>cmdb_ci_mainframe</td>
<td>IBM Mainframe</td>
<td>IBM large-scale computer system.</td>
</tr>
<tr>
<td>cmdb_ci_mainframe.hardware</td>
<td>Mainframe Hardware</td>
<td>The hardware components of a large-scale computer system.</td>
</tr>
<tr>
<td>cmdb_ci_mainframe_lpar</td>
<td>IBM Mainframe LPAR</td>
<td>Logical partition, which is commonly called an LPAR, and is a subset of a mainframes computer’s hardware resources, virtualized as a separate computer.</td>
</tr>
<tr>
<td>cmdb_ci_memory_module</td>
<td>Memory Module</td>
<td>Circuit board that provides for memory storage.</td>
</tr>
<tr>
<td>cmdb_ci_mfp_printer</td>
<td>Multi-function Printer</td>
<td>Physical device with scan, copy, and fax capabilities.</td>
</tr>
<tr>
<td>cmdb_ci_microsoft_iis_web_server</td>
<td>Microsoft iis Web Server</td>
<td>Server running Internet Information Services (IIS) for Windows software.</td>
</tr>
<tr>
<td>cmdb_ci_modem_network</td>
<td>Modem Hardware</td>
<td>Physical modem hardware.</td>
</tr>
<tr>
<td>cmdb_ci_mpio_pool</td>
<td>Multipath IO Pool</td>
<td>Multipath IO pool, representing multiple redundant paths to storage.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_mpio_pool_group</td>
<td>Multipath IO Pool Group</td>
<td>Group of multipath IO pools.</td>
</tr>
<tr>
<td>cmdb_ci_mpio_pool_path</td>
<td>Multipath IO Pool Path</td>
<td>Single path in an MPIO pool.</td>
</tr>
<tr>
<td>cmdb_ci_msd</td>
<td>Mass Storage Device</td>
<td>Physical storage device.</td>
</tr>
<tr>
<td>cmdb_ci_nat_gateway</td>
<td>NAT Gateway</td>
<td>Functionality for NAT gateway.</td>
</tr>
<tr>
<td>cmdb_ci_netapp_cdot</td>
<td>NetApp CDOT</td>
<td>Functionality of NetApp Clustered Data OnTap operating system.</td>
</tr>
<tr>
<td>cmdb_ci_netapp_datacenter</td>
<td>NetApp Datacenter</td>
<td>NetApp logical datacenter.</td>
</tr>
<tr>
<td>cmdb_ci_net_app_server</td>
<td>Network Appliance Hardware</td>
<td>Server configured to perform as a networking appliance.</td>
</tr>
<tr>
<td>cmdb_ci_netgear</td>
<td>Network Gear</td>
<td>Extension of the Hardware table, that captures network equipment such as router, switch, hub, gateway, and bridge.</td>
</tr>
<tr>
<td>cmdb_ci_netware_server</td>
<td>Netware Server</td>
<td>Server running NetWare software.</td>
</tr>
<tr>
<td>cmdb_ci_network</td>
<td>Cloud Network</td>
<td>VMware vCenter cloud network.</td>
</tr>
<tr>
<td>cmdb_ci_network_acl</td>
<td>Network ACL</td>
<td>Network access control list (ACL).</td>
</tr>
<tr>
<td>cmdb_ci_network_acl_rule</td>
<td>Network ACL Rule</td>
<td>Rule used to control networking access rights.</td>
</tr>
<tr>
<td>cmdb_ci_network_adapter</td>
<td>Network Adapter</td>
<td>Network adapter hardware.</td>
</tr>
<tr>
<td>cmdb_ci_network_policy_group</td>
<td>Network Policy Group</td>
<td>Group policy consumed by Active Directory services.</td>
</tr>
<tr>
<td>cmdb_ci_network_template</td>
<td>Network Template</td>
<td>OpenStack file used to configure a network.</td>
</tr>
<tr>
<td>cmdb_ci_nic</td>
<td>Cloud Mgmt Network Interface</td>
<td>Virtual network adapter.</td>
</tr>
<tr>
<td>cmdb_ci_nginx_web_server</td>
<td>Nginx Web Server</td>
<td>Server running Nginx software.</td>
</tr>
<tr>
<td>cmdb_ci_openstack_datacenter</td>
<td>OpenStack Datacenter</td>
<td>OpenStack logical datacenter.</td>
</tr>
<tr>
<td>cmdb_ci_oslv_container</td>
<td>Operating-system-level Virtualization Container</td>
<td>Containers (a runtime instance of a docker image).</td>
</tr>
<tr>
<td>cmdb_ci_oslv_engine</td>
<td>Operating-system-level Virtualization Engine</td>
<td>Software for running and managing containers.</td>
</tr>
<tr>
<td>cmdb_ci_oslv_image</td>
<td>Operating-system-level Virtualization Image</td>
<td>Container images. Ordered collection of root filesystem changes and the corresponding execution parameters for use within a container runtime.</td>
</tr>
<tr>
<td>cmdb_ci_oslv_image_tag</td>
<td>Operating-system-level Virtualization Image Tag</td>
<td>Container tag, which is a label applied to a container image in a repository.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_oslv_local_image</td>
<td>Operating-system-level Virtualization Local Image</td>
<td>Locally managed container image.</td>
</tr>
<tr>
<td>cmdb_ci_osx_server</td>
<td>OS/X Server</td>
<td>Server running OS/X operating system.</td>
</tr>
<tr>
<td>cmdb_ci_os_template</td>
<td>Image</td>
<td>Software files used to create a new instance of a compute resource such as server, desktop, virtual machine, and virtual router.</td>
</tr>
<tr>
<td>cmdb_ci_outofband_device</td>
<td>Out-of-Band Device</td>
<td>Hardware used to perform out-of-band management.</td>
</tr>
<tr>
<td>cmdb_ci_patches</td>
<td>Patch</td>
<td>Patch software to fix or improve a computer program or its supporting data.</td>
</tr>
<tr>
<td>cmdb_ci_pc_hardware</td>
<td>Personal Computer</td>
<td>Multi-purpose electronic computer whose size, capabilities, and price make it feasible for individual use.</td>
</tr>
<tr>
<td>cmdb_ci_pdu</td>
<td>PDU</td>
<td>Power distribution unit (PDU).</td>
</tr>
<tr>
<td>cmdb_ci_pdu_outlet</td>
<td>Outlet</td>
<td>Single outlet of a PDU.</td>
</tr>
<tr>
<td>cmdb_ci_peripheral</td>
<td>Computer Peripheral</td>
<td>Various computer peripherals such as monitor, docking station, KVM switch, projector, scanner, keyboard, mouse, and UPS.</td>
</tr>
<tr>
<td>cmdb_ci_personal_printer</td>
<td>Personal Printer</td>
<td>Printer whose size, capabilities and price make it feasible for individual use.</td>
</tr>
<tr>
<td>cmdb_ci_plotter</td>
<td>Plotter</td>
<td>Printer with capabilities to print large vector graphic images.</td>
</tr>
<tr>
<td>cmdb_ci_power_eq</td>
<td>Power Equipment</td>
<td>Hardware used to manage electrical power.</td>
</tr>
<tr>
<td>cmdb_ci_port</td>
<td>Port</td>
<td>Interface between a computer and other electronic devices.</td>
</tr>
<tr>
<td>cmdb_ci_port_group</td>
<td>Port Group</td>
<td>Group of ports on a virtual switch.</td>
</tr>
<tr>
<td>cmdb_ci_print_queue</td>
<td>Print Queue</td>
<td>Print queue, which is a list of printer output jobs held in a reserved memory area, including the most current status of all active and pending print jobs.</td>
</tr>
<tr>
<td>cmdb_ci_printer</td>
<td>Printer</td>
<td>Physical device which makes a persistent human-readable representation of graphics or text on paper or similar physical media.</td>
</tr>
<tr>
<td>cmdb_ci_printing_hardware</td>
<td>Printing Hardware</td>
<td>Physical device which makes a persistent human-readable representation of graphics or text on paper or similar physical media.</td>
</tr>
<tr>
<td>cmdb_ci_puppet_master</td>
<td>Puppet Master</td>
<td>Server running PuppetMaster application.</td>
</tr>
<tr>
<td>cmdb_ci_qtree</td>
<td>Qtree</td>
<td>Qtree file system.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_rack</td>
<td>Rack</td>
<td>Datacenter racks containing details such as rack units, rack units in use, and power consumption.</td>
</tr>
<tr>
<td>cmdb_ci_raid</td>
<td>RAID</td>
<td>Storage pool using RAID mechanisms to ensure data integrity.</td>
</tr>
<tr>
<td>cmdb_ci_raid_member</td>
<td>RAID Member</td>
<td>Member of storage pool using RAID mechanisms.</td>
</tr>
<tr>
<td>cmdb_ci_resource_group</td>
<td>Resource Group</td>
<td>Resource pool is a logical abstraction for flexible management of resources.</td>
</tr>
<tr>
<td>cmdb_ci_san</td>
<td>Storage Area Network</td>
<td>Network which provides access to block level storage.</td>
</tr>
<tr>
<td>cmdb_ci_san_connection</td>
<td>SAN Connection</td>
<td>Connection in a SAN network.</td>
</tr>
<tr>
<td>cmdb_ci_san_endpoint</td>
<td>SAN Endpoint</td>
<td>One end of a SAN connection.</td>
</tr>
<tr>
<td>cmdb_ci_san_fabric</td>
<td>SAN Fabric</td>
<td>Hardware that connects workstations and servers to storage devices in a SAN. Referred to as a &quot;fabric.&quot;</td>
</tr>
<tr>
<td>cmdb_ci_san_zone</td>
<td>SAN Zone</td>
<td>Subset of SAN storage that certain users are restricted to.</td>
</tr>
<tr>
<td>cmdb_ci_san_zone_alias</td>
<td>SAN Zone Alias</td>
<td>Collection of SAN zone members.</td>
</tr>
<tr>
<td>cmdb_ci_san_zone_alias_member</td>
<td>SAN Zone Alias Member</td>
<td>M2m relationship between SAN zone aliases and SAN zone members.</td>
</tr>
<tr>
<td>cmdb_ci_san_zone_member</td>
<td>SAN Zone Member</td>
<td>Ports and devices in a SAN zone.</td>
</tr>
<tr>
<td>cmdb_ci_san_zone_set</td>
<td>SAN Zone Set</td>
<td>Collection of SAN zones.</td>
</tr>
<tr>
<td>cmdb_ci_scanner</td>
<td>Scanner</td>
<td>Hardware used to create digital imagine of paper documents.</td>
</tr>
<tr>
<td>cmdb_ci_server</td>
<td>Server</td>
<td>Base class for all types of servers.</td>
</tr>
<tr>
<td>cmdb_ci_server_snapshot</td>
<td>Server Snapshot</td>
<td>Server snapshot, which is the state of a system at a particular point in time.</td>
</tr>
<tr>
<td>cmdb_ci_service</td>
<td>Business Service</td>
<td>IT Service that directly supports a Business Process (ITIL).</td>
</tr>
<tr>
<td>cmdb_ci_solaris_instance</td>
<td>Solaris Virtual Machine Instance</td>
<td>Virtual machine instance running Solaris software.</td>
</tr>
<tr>
<td>cmdb_ci_solaris_server</td>
<td>Solaris Server</td>
<td>Physical server running Solaris software.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_spkg</td>
<td>Software</td>
<td>Software package information containing details such as version, install count, license count, package name, and key (when SAM enabled).</td>
</tr>
<tr>
<td>cmdb_ci_storage_controller</td>
<td>Storage Controller</td>
<td>Logical device that controls a storage volume or Fibre Channel port.</td>
</tr>
<tr>
<td>cmdb_ci_storage_device</td>
<td>Storage Device</td>
<td>Base table for block storage devices such as DAS, SAN, and NAS.</td>
</tr>
<tr>
<td>cmdb_ci_storage_disk</td>
<td>Storage Disk</td>
<td>Disk installed in a storage server.</td>
</tr>
<tr>
<td>cmdb_ci_storage_export</td>
<td>Storage Export</td>
<td>Base table for the SAN Export [cmdb_ci_san_export] table.</td>
</tr>
<tr>
<td>cmdb_ci_storage_fileshare</td>
<td>Storage File Share</td>
<td>NAS file system on a storage server (an exported file system).</td>
</tr>
<tr>
<td>cmdb_ci_storage_hba</td>
<td>Storage HBA</td>
<td>Host bust adapter for Fibre Channel. The physical device that provides Fibre Channel ports.</td>
</tr>
<tr>
<td>cmdb_ci_storage_pool</td>
<td>Storage Pool</td>
<td>Logical collection of storage.</td>
</tr>
<tr>
<td>cmdb_ci_storage_pool_member</td>
<td>Storage Pool Member</td>
<td>Logical volume in a storage pool.</td>
</tr>
<tr>
<td>cmdb_ci_storage_switch</td>
<td>Storage Switch</td>
<td>Fibre Channel switch.</td>
</tr>
<tr>
<td>cmdb_ci_storage_volume</td>
<td>Storage Volume</td>
<td>Volume on a storage server.</td>
</tr>
<tr>
<td>cmdb_ci_storage_vol_snapshot</td>
<td>Storage Volume Snapshot</td>
<td>Server snapshot is the state of a system at a particular point in time.</td>
</tr>
<tr>
<td>cmdb_ci_subnet</td>
<td>Cloud Mgmt Subnet</td>
<td>Part of a larger network.</td>
</tr>
<tr>
<td>cmdb_ci_surge_power_eq</td>
<td>Surger Protection Equipment</td>
<td>Power equipment used to prevent power surges.</td>
</tr>
<tr>
<td>cmdb_ci_tape_server</td>
<td>Server Tape Unit</td>
<td>Hardware for using magnetic tape storage.</td>
</tr>
<tr>
<td>cmdb_ci_tomcat_connector</td>
<td>Tomcat Connector</td>
<td>Software which provides web server plugins to connect web servers with Tomcat and other backends.</td>
</tr>
<tr>
<td>cmdb_ci_translation_rule</td>
<td>NAT</td>
<td>Rules to allow router to remap one network address to another.</td>
</tr>
<tr>
<td>cmdb_ci_ucs_blade</td>
<td>Cisco UCS Blade</td>
<td>Physical Cisco UCS Blade server hardware.</td>
</tr>
<tr>
<td>cmdb_ci_ucs_chassis</td>
<td>Cisco UCS Chassis</td>
<td>Physical Cisco UCS chassis hardware used to hold Cisco UCS Blade server hardware.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_unix_cluster</td>
<td>UNIX Cluster</td>
<td>Set of computers clustered together to present a single Unix server resource.</td>
</tr>
<tr>
<td>cmdb_ci_unix_daemon</td>
<td>UNIX Daemon</td>
<td>Long running Unix background process used to answer requests for services.</td>
</tr>
<tr>
<td>cmdb_ci_unix_server</td>
<td>UNIX Server</td>
<td>Server running Unix software.</td>
</tr>
<tr>
<td>cmdb_ci_ups</td>
<td>UPS</td>
<td>Uninterrupted Power Supply devices.</td>
</tr>
<tr>
<td>cmdb_ci_ups_alarm</td>
<td>UPS Alarm</td>
<td>Uninterrupted Power Supply alarm.</td>
</tr>
<tr>
<td>cmdb_ci_ups_bypass</td>
<td>UPS Bypass</td>
<td>Uninterrupted Power Supply bypass.</td>
</tr>
<tr>
<td>cmdb_ci_ups_input</td>
<td>UPS Input</td>
<td>Electrical input to an Uninterrupted Power Supply device.</td>
</tr>
<tr>
<td>cmdb_ci_ups_output</td>
<td>UPS Output</td>
<td>Electrical output from an Uninterrupted Power Supply device.</td>
</tr>
<tr>
<td>cmdb_ci_ups_power_eq</td>
<td>Uninterruptible Power Supply</td>
<td>Uninterrupted Power Supply devices.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter</td>
<td>VMware vCenter Instance</td>
<td>Installed instance of VMware VCenter software.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_cluster</td>
<td>VMware vCenter Cluster</td>
<td>Set of servers that work together while running VMware VCenter software.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_datacenter</td>
<td>VMware vCenter Datacenter</td>
<td>VMware VCenter data center objects.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_datastore</td>
<td>VMware vCenter Datastore</td>
<td>VMware VCenter datastore objects containing details such as capacity, freespace, filesystem, and type.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_datastore_disk</td>
<td>Datastore Disk</td>
<td>Individual VMware VCenter datastore disk.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_folder</td>
<td>VMware vCenter Folder</td>
<td>VCenter folders, which can be used to group objects of the same type for easier management.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_network</td>
<td>VMware vCenter Network</td>
<td>VMware VCenter virtual network.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_object</td>
<td>VMware vCenter Object</td>
<td>Base class for most VMware VCenter objects.</td>
</tr>
<tr>
<td>cmdb_ci_vcenter_server_obj</td>
<td>VMware vCenter Server Object</td>
<td>VMware hypervisor.</td>
</tr>
<tr>
<td>cmdb_ci_veritas_disk</td>
<td>Veritas Disk</td>
<td>Physical disk that is controlled by Veritas Volume Manager.</td>
</tr>
<tr>
<td>cmdb_ci_veritas_disk_group</td>
<td>Veritas Disk Group</td>
<td>Collection of disks in Veritas Volume Manager.</td>
</tr>
<tr>
<td>cmdb_ci_veritas_plex</td>
<td>Veritas Plex</td>
<td>Logical partition in Veritas Volume Manager.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_veritas_subdisk</td>
<td>Veritas Subdisk</td>
<td>Partition of a Veritas_disk.</td>
</tr>
<tr>
<td>cmdb_ci_veritas_volume</td>
<td>Veritas Volume</td>
<td>Aggregation of plexes.</td>
</tr>
<tr>
<td>cmdb_ci_virtualization_server</td>
<td>Virtualization Server</td>
<td>Base table used by the ESXServer [cmdb_ci_esx_server] table.</td>
</tr>
<tr>
<td>cmdb_ci_virtual_desktop</td>
<td>Virtual Desktop</td>
<td>User's desktop environment (such as icons, wallpaper, windows, folders, toolbars, and widgets) is stored remotely on a server.</td>
</tr>
<tr>
<td>cmdb_ci_virtual_pvt_gateway</td>
<td>Virtual Private Gateway</td>
<td>Two VPN endpoints for automatic failover.</td>
</tr>
<tr>
<td>cmdb_ci_vm</td>
<td>Virtual Machine HyperVisor</td>
<td>Hypevisor software.</td>
</tr>
<tr>
<td>cmdb_ci_vm_instance</td>
<td>Virtual Machine Instance</td>
<td>Generic virtual machines information.</td>
</tr>
<tr>
<td>cmdb_ci_vm_object</td>
<td>Virtual Machine Object</td>
<td>Base class for all VM objects. Parent for all objects such as Hyper-V object and KVM object.</td>
</tr>
<tr>
<td>cmdb_ci_vm_parallels</td>
<td>Parallels</td>
<td>Instance of Parallels software.</td>
</tr>
<tr>
<td>cmdb_ci_vm_template</td>
<td>Virtual Machine Template</td>
<td>Template, which is a master copy of a virtual machine that can be used to create many clones. Base table for all VM templates.</td>
</tr>
<tr>
<td>cmdb_ci_vm_user_credentials</td>
<td>VM User Credentials</td>
<td>Credentials, which are used to authenticate access rights and permissions.</td>
</tr>
<tr>
<td>cmdb_ci_vm.vmware</td>
<td>VMware</td>
<td>VMWare specialization of the Virtual Machine table. No longer used.</td>
</tr>
<tr>
<td>cmdb_ci_vm_zones</td>
<td>Zones</td>
<td>Partitioned virtual OS environment working in a Solaris operating system space.</td>
</tr>
<tr>
<td>cmdb_ci_volume_template</td>
<td>Volume Template</td>
<td>Set of rules that specify one or more capabilities of a storage volume (storage selection and layout rules).</td>
</tr>
<tr>
<td>cmdb_ci_vmware_instance</td>
<td>VMware Virtual Machine Instance</td>
<td>VMware VM instance on VMware hypervisor.</td>
</tr>
<tr>
<td>cmdb_ci_vmware_template</td>
<td>VMware Virtual Machine Template</td>
<td>Master copy of a VMware virtual machine that can be used to create many clones.</td>
</tr>
<tr>
<td>cmdb_ci_vpc</td>
<td>Virtual Private Cloud</td>
<td>On-demand configurable pool of shared computing resources allocated within a public cloud environment.</td>
</tr>
<tr>
<td>cmdb_ci_vpn</td>
<td>Virtual Private Network</td>
<td>Private network configured to run across a public network.</td>
</tr>
<tr>
<td>cmdb_ci_vpn_connection</td>
<td>VPN Connection</td>
<td>Secure connection to another network over the Internet.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table label</td>
<td>Table description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_wap_network</td>
<td>Wireless Access Point</td>
<td>Networking hardware device that allows a Wi-Fi compliant device to connect to a wired network.</td>
</tr>
<tr>
<td>cmdb_ci_web_application</td>
<td>Web Application</td>
<td>Client–server software application in which the client (or user interface) runs in a web browser.</td>
</tr>
<tr>
<td>cmdb_ci_web_domino</td>
<td>Lotus Domino HTTP Server</td>
<td>Server running IBM Notes software (formerly Lotus Notes/IBM Domino).</td>
</tr>
<tr>
<td>cmdb_ci_web_service</td>
<td>Web Service</td>
<td>Service offered by an electronic device to another electronic device, communicating with each other via the World Wide Web.</td>
</tr>
<tr>
<td>cmdb_ci_web_site</td>
<td>Web Site</td>
<td>A collection of related web pages.</td>
</tr>
<tr>
<td>cmdb_ci_websphere_cell</td>
<td>Websphere Cell</td>
<td>A logical grouping of IBM Websphere nodes (each of which runs one or more application servers) that are centrally managed.</td>
</tr>
<tr>
<td>cmdb_ci_win_cluster</td>
<td>Windows Cluster</td>
<td>A single (virtual) server composed of one ore more physical Windows Servers.</td>
</tr>
<tr>
<td>cmdb_ci_win_cluster_node</td>
<td>Windows Cluster Node</td>
<td>A physical member of the Windows Cluster application.</td>
</tr>
<tr>
<td>cmdb_ci_win_cluster_resource</td>
<td>Windows Cluster Resource</td>
<td>A logical or physical entity managed by the Windows Cluster application.</td>
</tr>
<tr>
<td>cmdb_ci_win_domain_controller</td>
<td>Windows Domain Controller</td>
<td>A server that responds to security authentication requests within a Windows Server domain.</td>
</tr>
<tr>
<td>cmdb_ci_win_server</td>
<td>Windows Server</td>
<td>A server running Microsoft Windows Server operating system.</td>
</tr>
<tr>
<td>cmdb_ci_windows_service</td>
<td>Windows Service</td>
<td>A Windows computer program that operates in the background.</td>
</tr>
<tr>
<td>cmdb_ci_zone</td>
<td>Data Center Zone</td>
<td>A specified portion of a data center facility.</td>
</tr>
</tbody>
</table>

**Configuration Item [cmdb_ci] class**

Attributes in the Configuration Item [cmdb_ci] class, which extends the Configuration Item [cmdb] class.
**Attention:** Do not modify any of these attributes in the dictionary. For example, do not modify the type of the `location` attribute from reference to list. Such modifications may prevent features that use the CMDB, from functioning properly.

**Common, core, user tables**
CMDB CI schema related to common core and non-core tables

Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset tag</td>
<td>Asset tag/service tag for the specific asset</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assigned</td>
<td>Date and time of assignment to user</td>
</tr>
<tr>
<td>Attributes</td>
<td>Description of usage of attributes for the instance</td>
</tr>
<tr>
<td>Can Print</td>
<td>Indicates whether the instance can print</td>
</tr>
<tr>
<td>Category</td>
<td>Name of category applicable to the instance</td>
</tr>
<tr>
<td>Checked in</td>
<td>Date and time of checking in</td>
</tr>
<tr>
<td>Checked out</td>
<td>Date and time of checking out</td>
</tr>
<tr>
<td>Class</td>
<td>System class name</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments related to the instance</td>
</tr>
<tr>
<td>Correlation ID</td>
<td>ID of the instance from another data source</td>
</tr>
<tr>
<td>Cost</td>
<td>Financial value in local currency (as defined in the Cost Currency field)</td>
</tr>
<tr>
<td>Cost currency</td>
<td>Name of currency (such as dollars, pounds, Euros)</td>
</tr>
<tr>
<td>Created</td>
<td>Date and time record was created</td>
</tr>
<tr>
<td>Created by</td>
<td>Name of person/data source which initially created the record</td>
</tr>
<tr>
<td>Description</td>
<td>Fit (how deployed) and function (purpose) of the instance</td>
</tr>
<tr>
<td>Discovery source</td>
<td>Name of primary (most trusted) discovery source</td>
</tr>
<tr>
<td>DNS Domain</td>
<td>Name of the DNS domain to which the instance belongs</td>
</tr>
<tr>
<td>Domain</td>
<td>ID of the domain to which the instance belongs</td>
</tr>
<tr>
<td>Domain Path</td>
<td>Path of the domain to which the instance belongs</td>
</tr>
<tr>
<td>Due</td>
<td>Date and time instance was due</td>
</tr>
<tr>
<td>Due in</td>
<td>Description of the manner of which the instance was due</td>
</tr>
<tr>
<td>Fault Count</td>
<td>Number of faulty recorded against the instance to date</td>
</tr>
<tr>
<td>First Discovered</td>
<td>Date and time instance was initially discovered</td>
</tr>
<tr>
<td>Fully Qualified Domain Name</td>
<td>Full path name of domain to which the instance belongs</td>
</tr>
<tr>
<td>GL account</td>
<td>General Ledger account name/number</td>
</tr>
<tr>
<td>Installed</td>
<td>Date and time instance was most recently installed</td>
</tr>
<tr>
<td>Invoice number</td>
<td>Invoice number used in acquisition process</td>
</tr>
<tr>
<td>IP Address</td>
<td>Primary IP address used by the instance</td>
</tr>
<tr>
<td>Justification</td>
<td>Description of the justification for the instance</td>
</tr>
<tr>
<td>Lease contract</td>
<td>Number of current leasing contracts</td>
</tr>
<tr>
<td>MAC Address</td>
<td>MAC address of the instance</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------------------------------------</td>
</tr>
<tr>
<td>Model Number</td>
<td>Manufacturer original model number</td>
</tr>
<tr>
<td>Monitor</td>
<td>Indicates whether the instance is monitored</td>
</tr>
<tr>
<td>Most Recent Discovery</td>
<td>Date and time instance was last discovered</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the CI instance</td>
</tr>
<tr>
<td>Operational Status</td>
<td>Configurable choice list for current operational states</td>
</tr>
<tr>
<td>Order received</td>
<td>Date and time instance was initially received</td>
</tr>
<tr>
<td>Ordered</td>
<td>Date and time instance was initially ordered</td>
</tr>
<tr>
<td>PO number</td>
<td>Purchase order number used in acquisition process</td>
</tr>
<tr>
<td>Purchased</td>
<td>Date instance was purchased</td>
</tr>
<tr>
<td>Requires verification</td>
<td>Flag indicating whether verification is required for the instance</td>
</tr>
<tr>
<td>Serial number</td>
<td>Serial number of the instance</td>
</tr>
<tr>
<td>Skip sync</td>
<td>Flag indicating whether synchronization between Asset Management and CMDB can be skipped</td>
</tr>
<tr>
<td>Start Date</td>
<td>Date and time the instance was last started</td>
</tr>
<tr>
<td>Status</td>
<td>Configurable choice list with values for current functional states</td>
</tr>
<tr>
<td>Subcategory</td>
<td>Name of Subcategory applicable to the instance</td>
</tr>
<tr>
<td>Sys ID</td>
<td>ServiceNow Sys ID (GUID)</td>
</tr>
<tr>
<td>Tags</td>
<td>Related tags</td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time instance was last updated</td>
</tr>
<tr>
<td>Updated by</td>
<td>Person/data source which last updated the record</td>
</tr>
<tr>
<td>Updates</td>
<td>Configurable choice list with values for update states</td>
</tr>
<tr>
<td>Warranty expiration</td>
<td>Date current warranty expires</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reference attribute</th>
<th>Reference to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Group</td>
<td>Group table</td>
</tr>
<tr>
<td>Asset</td>
<td>Asset table</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User table</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group table</td>
</tr>
<tr>
<td>Company</td>
<td>Company table</td>
</tr>
<tr>
<td>Cost center</td>
<td>Cost Center table</td>
</tr>
<tr>
<td>Department</td>
<td>Department table</td>
</tr>
<tr>
<td>Location</td>
<td>Location table</td>
</tr>
<tr>
<td>Maintenance Schedule</td>
<td>Schedule table</td>
</tr>
<tr>
<td>Reference attribute</td>
<td>Reference to</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Managed by</td>
<td>User table</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Company table</td>
</tr>
<tr>
<td>Model ID</td>
<td>Product Model table</td>
</tr>
<tr>
<td>Owned by</td>
<td>User table</td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule table (for normal processing)</td>
</tr>
<tr>
<td>Support group</td>
<td>Group table</td>
</tr>
<tr>
<td>Supported by</td>
<td>User</td>
</tr>
<tr>
<td>Vendor</td>
<td>Company table</td>
</tr>
</tbody>
</table>

**Hardware [cmdb_ci_hardware] class**

Attributes, identification rule, and other important schema structures for the CMDB Hardware [cmdb_ci_hardware] class.
Attributes

The Hardware class adds the following unique attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hardware_status</td>
<td>Status of hardware such as In Maintenance or Retired. Used to sync status to the Asset class.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>hardware_substatus</td>
<td>Secondary hardware status. Each setting in <code>hardware_status</code> results in a different set of choices available for this field.</td>
</tr>
<tr>
<td>default_gateway</td>
<td>Default gateway that the computer is connected through.</td>
</tr>
</tbody>
</table>

**Key relationship structures**

Use the following key relationships as important guidelines when creating Hardware, Computer, or Server CIs:

- **Serial number**: During CI identification, Identification and Reconciliation Engine (IRE) processes search for a serial number in two locations. One is the CI serial number attribute, and the second one is the Serial Number [cmdb_serial_number] table, with reference back to the Hardware [cmdb_ci_hardware] table.
  - Store any serial number of any type other than System, only in the Serial Number table (and not in the server CI attribute).
  - If the system serial number is available, store it in both the `Serial Number` attribute of the CI and in the Serial Number table.

The Serial Number table is a many to one relationship linking back to the server CI. This table has a type field for specifying the type of the serial number (system, uuid, chassis, bios, or baseboard) and storing the actual value itself. Use the following Windows standards for serial number types in the Serial Number [cmdb_serial_number] table:

- **system**: Product identification such as a serial number for software, a die number on a hardware chip, or a project number (for noncommercial products).
- **uuid**: Universally unique identifier (UUID) for the product. A UUID is a 128-bit identifier that is guaranteed to be different from other generated UUIDs.
- **chassis**: Manufacturer-allocated number that is used to identify a physical element. Value is the Serial Number member of the System Enclosure or Chassis structure in the SMBIOS information. This type represents the properties associated with a physical system enclosure.
- **bios**: The assigned serial number of the BIOS. This type represents the attributes of the computer system basic input/output services (BIOS) that are installed on the computer.
- **baseboard**: Manufacturer-allocated number that is used to identify the physical element. This property is inherited from CIM_PhysicalElement, and is sometimes referred to as the ‘Motherboard Serial Number’.

- **Network adapter**:
  - Use the Network Adapter [cmdb_ci_network_adapter] class to store network adapters.
  - Set the `Name` attribute in the Network Adapter class to be the name of the Network Adapter device (such as eth0, eth1).
  - Set the `MAC Address` attribute to be the MAC address value. Format the string with colon separators between octets and lower case hexadecimal characters with padded zeros.
    
    For example: `f8:f2:1e:00:d4:66`
  - In the CI Relationship [cmdb_rel_ci] table, create an **Owned By::Owns** relationship to the associated Hardware CI. Specify a reference from the Network Adapter [cmdb_ci_network_adapter] table using the CI with a reference to the associated Hardware CI.
• IP address:
  • Use the IP Address [cmdb_ci_ip_address] class to store IP addresses.
  • Store an IP address value in the IP Address attribute, and in the Name attribute (to avoid empty Name attributes).
  • Store an IPv4 IP address value using the format ‘NNN.NNN.NNN.NNN’, with decimal-based octets and period separators. Non-conforming values should be considered invalid and cleansed to null values.
  • Store an IPv6 IP address value using lower case hexadecimal with colon separators. Non-confirming values should be considered invalid and cleansed to null values.
  • Set the Netmask attribute to the IP address.
  • In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns relationship to the associated Hardware hierarchy CI.
  • Specify for the IP address a reference to the Network Adapter [cmdb_ci_network_adapter] table using the Configuration Item with a reference to the associated Hardware CI.
  • To ensure that base system identification rules work properly, also store the IP address in the associated Network Adapter class.

• Network adapter and IP address:
  • Store the MAC address of the network adapter installed on a server, in the Network Adapter [cmdb_ci_network_adapter] class.
  • Store the IP address in the IP Address [cmdb_ci_ip_address] class.
  • Do not store the MAC address or the IP address in the Server [cmdb_ci_server] class.

Key reference structures

Use the following key references as important guidelines when creating Hardware, Computer, or Server CIs:

• Software and processes running on a server: The Software [cmdb_ci_spkg] class contains the generic software package that is related to the server CI. The cmdb_sw_instance table instantiates each instance of the software package with:
  • One to one reference back to the Server [cmdb_ci_server] class
  • Many to one reference back to the Software class

These references are stored in the Installed on and the Product Name reference attributes respectively.

If either the Software Asset Management Foundation [com.snc.sams] or the Software Asset Management [com.snc.software_asset_management] plugin is installed, then store software details in the Software Installation [cmdb_sam_sw_install] table instead of the cmdb_sw_instance table.

• The Manufacturer and Model ID are reference attributes to the Company [core_company] and Product Model [cmdb_model] tables respectively.

• The Owned By, Assigned To, Managed By, and Supported By are reference attributes to the User [sys_user] table. The Assignment Group and Support Group are reference attributes to the Group [sys_user_group] table.

Identification rule

The base system contains pre-defined identification rules for the Hardware, Computer, and Server classes, which are identical. That identification rule has the following key identifier entries, listed in priority order:
1. Identifier entry which uses lookup-based identification specified with Serial Number [cmdb_serial_number] as the lookup table. The Serial Number table is a many to one reference from Serial Number back to the server CI.

2. Identifier entry specified with the Serial Number attribute in the CI.

3. Identifier entry for the Name attribute. If Serial Number is not available, then the Name (which is the hostname) attribute is used. If both the Serial Number and the Name attributes are provided, then Identification and Reconciliation Engine (IRE) looks first for the Serial Number. Then, if a Serial Number is not found, IRE falls back to using Name.

4. Identifier entry specified for the MAC Address/IP Address attributes in the Network Adapter table. However, do not rely only on the MAC Address/IP Address.

   If both Serial Number and Name are not available, and only MAC Address/IP Address are available, use MAC Address as the name of the CI. Using the MAC Address as the name of the CI ensures that you don't create an empty CI.

For more information, see CMDB Identification and Reconciliation.

**Computer [cmdb_ci_computer] class**

Attributes, identification rule, and other important schema structures for the CMDB Computer [cmdb_ci_computer] class.
Attributes

The Computer class adds the following unique attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD_ROM</td>
<td>Denotes whether a CD ROM exists.</td>
</tr>
<tr>
<td>CD Speed</td>
<td>Speed of CD_ROM.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Chassis type</td>
<td>Type of computer chassis.</td>
</tr>
<tr>
<td>CPU core count</td>
<td>Number of cores per CPU.</td>
</tr>
<tr>
<td>CPU core thread</td>
<td>Number of threads per core.</td>
</tr>
<tr>
<td>CPU count</td>
<td>Number of CPUs.</td>
</tr>
<tr>
<td>CPU name</td>
<td>Name of CPU.</td>
</tr>
<tr>
<td>CPU speed (MHz)</td>
<td>Speed of CPU.</td>
</tr>
<tr>
<td>CPU type</td>
<td>CPU type.</td>
</tr>
<tr>
<td>Disk space (GB)</td>
<td>Amount of disk space (in GB).</td>
</tr>
<tr>
<td>Floppy</td>
<td>Type of floppy drive.</td>
</tr>
<tr>
<td>Form factor</td>
<td>Form factor of the computer.</td>
</tr>
<tr>
<td>Object ID</td>
<td>Object ID of the computer (such as the virtual machine ID associated with the computer).</td>
</tr>
<tr>
<td>Operating System</td>
<td>Name of the operating system.</td>
</tr>
<tr>
<td>OS Address Width (bits)</td>
<td>Operating system bit (such as 32, 64).</td>
</tr>
<tr>
<td>OS Domain</td>
<td>NA</td>
</tr>
<tr>
<td>OS Service Pack</td>
<td>Service pack installed on the operating system.</td>
</tr>
<tr>
<td>OS Version</td>
<td>Version of the operating system.</td>
</tr>
<tr>
<td>RAM (MB)</td>
<td>Amount of RAM on the computer.</td>
</tr>
<tr>
<td>IsVirtual</td>
<td>True/False denoting whether the device is running on a virtual machine instance.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reference attribute</th>
<th>Reference to</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU manufacturer</td>
<td>Company [core_company] table</td>
</tr>
</tbody>
</table>

**Schema description**

The CMDB schema model does not separate between servers and computers that are physical and servers and computer that are virtual. Instead, the Computer and the Server classes have a field named **IsVirtual**. If a computer or server is a virtual instance, set this **IsVirtual** attribute to **true**.

As described in the Virtual Machine schema section, to fully model a virtual machine, set the **IsVirtual** attribute in the Computer or Server CI to **true**. Create a Virtual Machine Instance [cmdb_ci_vm_instance] record using the **BIOS UUID** attribute as the key identifier. Then create a Hosted_On relationship between the Virtual Machine Instance record and the Computer or Server instance and set **IsVirtual** to **true**.

**Key relationship structures**

Use the following key relationships as important guidelines when creating Hardware, Computer, or Server CIs:
• Serial number: During CI identification, Identification and Reconciliation Engine (IRE) processes search for a serial number in two locations. One is the CI serial number attribute, and the second one is the Serial Number [cmdb_serial_number] table, with reference back to the Hardware [cmdb_ci_hardware] table.
  
  • Store any serial number of any type other than System, only in the Serial Number table (and not in the server CI attribute).
  
  • If the system serial number is available, store it in both the Serial Number attribute of the CI and in the Serial Number table.

The Serial Number table is a many to one relationship linking back to the server CI. This table has a type field for specifying the type of the serial number (system, uuid, chassis, bios, or baseboard) and storing the actual value itself. Use the following Windows standards for serial number types in the Serial Number [cmdb_serial_number] table:

  • system: Product identification such as a serial number for software, a die number on a hardware chip, or a project number (for noncommercial products).
  
  • uuid: Universally unique identifier (UUID) for the product. A UUID is a 128-bit identifier that is guaranteed to be different from other generated UUIDs.
  
  • chassis: Manufacturer-allocated number that is used to identify a physical element. Value is the Serial Number member of the System Enclosure or Chassis structure in the SMBIOS information. This type represents the properties associated with a physical system enclosure.
  
  • bios: The assigned serial number of the BIOS. This type represents the attributes of the computer system basic input/output services (BIOS) that are installed on the computer.
  
  • baseboard: Manufacturer-allocated number that is used to identify the physical element. This property is inherited from CIM_PhysicalElement, and is sometimes referred to as the ‘Motherboard Serial Number’.

• Network adapter:
  
  • Use the Network Adapter [cmdb_ci_network_adapter] class to store network adapters.
  
  • Set the Name attribute in the Network Adapter class to be the name of the Network Adapter device (such as eth0, eth1).
  
  • Set the MAC Address attribute to be the MAC address value. Format the string with colon separators between octets and lower case hexadecimal characters with padded zeros.

  For example: ‘f8:f2:1e:00:d4:66’
  
  • In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns relationship to the associated Hardware CI. Specify a reference from the Network Adapter [cmdb_ci_network_adapter] table using the CI with a reference to the associated Hardware CI.
• IP address:
  • Use the IP Address [cmdb_ci_ip_address] class to store IP addresses.
  • Store an IP address value in the **IP Address** attribute, and in the **Name** attribute (to avoid empty **Name** attributes).
  • Store an IPv4 IP address value using the format 'NNN.NNN.NNN.NNN', with decimal-based octets and period separators. Non-conforming values should be considered invalid and cleansed to null values.
  • Store an IPv6 IP address value using lower case hexadecimal with colon separators. Non-confirming values should be considered invalid and cleansed to null values.
  • Set the **Netmask** attribute to the IP address.
  • In the CI Relationship [cmdb_rel_ci] table, create an **Owned By::Owns** relationship to the associated Hardware hierarchy CI.
  • Specify for the IP address a reference to the Network Adapter [cmdb_ci_network_adapter] table using the Configuration Item with a reference to the associated Hardware CI.
  • To ensure that base system identification rules work properly, also store the IP address in the associated Network Adapter class.

• Network adapter and IP address:
  • Store the MAC address of the network adapter installed on a server, in the Network Adapter [cmdb_ci_network_adapter] class.
  • Store the IP address in the IP Address [cmdb_ci_ip_address] class.
  • Do not store the MAC address or the IP address in the Server [cmdb_ci_server] class.

### Key reference structures

Use the following key references as important guidelines when creating Hardware, Computer, or Server CIs:

• Software and processes running on a server: The Software [cmdb_ci_spkg] class contains the generic software package that is related to the server CI. The cmdb_sw_instance table instantiates each instance of the software package with:
  • One to one reference back to the Server [cmdb_ci_server] class.
  • Many to one reference back to the Software class.

These references are stored in the **Installed on** and the **Product Name** reference attributes respectively.

If either the Software Asset Management Foundation [com.snc.sams] or the Software Asset Management [com.snc.software_asset_management] plugin is installed, then store software details in the Software Installation [cmdb_sam_sw_install] table instead of the cmdb_sw_instance table.

• The **Manufacturer** and **Model ID** are reference attributes to the Company [core_company] and Product Model [cmdb_model] tables respectively.

• The **Owned By**, **Assigned To**, **Managed By**, and **Supported By** are reference attributes to the User [sys_user] table. The **Assignment Group** and **Support Group** are reference attributes to the Group [sys_user_group] table.

### Identification rule

The base system contains pre-defined identification rules for the Hardware, Computer, and Server classes, which are identical. That identification rule has the following key identifier entries, listed in priority order:
1. Identifier entry which uses lookup-based identification specified with Serial Number [cmdb_serial_number] as the lookup table. The Serial Number table is a many to one reference from Serial Number back to the server CI.

2. Identifier entry specified with the Serial Number attribute in the CI.

3. Identifier entry for the Name attribute. If Serial Number is not available, then the Name (which is the hostname) attribute is used. If both the Serial Number and the Name attributes are provided, then Identification and Reconciliation Engine (IRE) looks first for the Serial Number. Then, if a Serial Number is not found, IRE falls back to using Name.

4. Identifier entry specified for the MAC Address/IP Address attributes in the Network Adapter table. However, do not rely only on the MAC Address/IP Address. If both Serial Number and Name are not available, and only MAC Address/IP Address are available, use MAC Address as the name of the CI. Using the MAC Address as the name of the CI ensures that you don't create an empty CI.

For more information, see CMDB Identification and Reconciliation.

**Server [cmdb_ci_server] class**

Attributes, identification rule, and other important schema structures for the CMDB Server [cmdb_ci_server] class.
Attributes

The Server class adds the following unique attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classification</td>
<td>Type of server, such as production, development, disaster recovery, or user acceptance testing (UAT).</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firewall status</td>
<td>Internet or intranet facing server.</td>
</tr>
<tr>
<td>Host name</td>
<td>Use the Name attribute to store the host name of the server instead of the Host name attribute.</td>
</tr>
<tr>
<td>Used for</td>
<td>Business service supported by the server, such as production, staging, or quality assurance (QA). This attribute uses the Used for choice list field from the Service [cmdb_ci_service] table.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reference attribute</th>
<th>Reference to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disaster backup</td>
<td>Server [cmdb_ci_server] table. Reference to another server that is the backup server for this server.</td>
</tr>
</tbody>
</table>

### Reference classes

The following reference classes extend the Server class. They do not add any new attributes.

<table>
<thead>
<tr>
<th>Reference class</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmdb_ci_solaris_server</td>
<td>Solaris Server</td>
<td>Server running Oracle Solaris operating system.</td>
</tr>
<tr>
<td>cmdb_ci_lb_cisco_csm</td>
<td>Cisco CSM</td>
<td>Cisco Security Manager (CSM) load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_win_server</td>
<td>Windows Server</td>
<td>Server running Microsoft Windows Server operating system.</td>
</tr>
<tr>
<td>cmdb_ci_lb_ace</td>
<td>ACE</td>
<td>Cisco Application Control Engine load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_netscaler</td>
<td>Citrix Netcaler</td>
<td>Citrix Netcaler load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_alteon</td>
<td>Alteon</td>
<td>Alteon load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_a10</td>
<td>A10 Load Balancer</td>
<td>A10 load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_cisco_css</td>
<td>Cisco CSS</td>
<td>Cisco Content Services Switch (CSS) load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_lb_cisco_gss</td>
<td>Cisco GSS</td>
<td>Cisco Global Site Selector (GSS) load balancer.</td>
</tr>
<tr>
<td>cmdb_ci_osx_Server</td>
<td>OS/X Server</td>
<td>Server running OS/X operating system.</td>
</tr>
<tr>
<td>cmdb_ci_HPUX_Server</td>
<td>HPUX Server</td>
<td>Server running HP-UX operating system.</td>
</tr>
<tr>
<td>cmdb_ci_tape_server</td>
<td>Server Tape Unit</td>
<td>Server using a tape drive.</td>
</tr>
<tr>
<td>cmdb_ci_Server_Hardware</td>
<td>Server Hardware</td>
<td>Server hardware.</td>
</tr>
<tr>
<td>cmdb_ci_datapower_server</td>
<td>Data Power Hosting Server</td>
<td>IBM DataPower hosting server.</td>
</tr>
</tbody>
</table>
### Schema description

The CMDB schema model does not separate between servers and computers that are physical and servers and computer that are virtual. Instead, the Computer and the Server classes have a field named `IsVirtual`. If a computer or server is a virtual instance, set this `IsVirtual` attribute to `true`.

As described in the Virtual Machine schema section, to fully model a virtual machine, set the `IsVirtual` attribute in the Computer or Server CI to `true`. Create a Virtual Machine Instance [cmdb_ci_vm_instance] record using the `BIOS UUID` attribute as the key identifier. Then create a Hosted_On relationship between the Virtual Machine Instance record and the Computer or Server instance and set `IsVirtual` to `true`.

### Key relationship structures

Use the following key relationships as important guidelines when creating Hardware, Computer, or Server CIs:

- **Serial number**: During CI identification, Identification and Reconciliation Engine (IRE) processes search for a serial number in two locations. One is the CI serial number attribute, and the second one is the Serial Number [cmdb_serial_number] table, with reference back to the Hardware [cmdb_ci_hardware] table.
  - Store any serial number of any type other than System, only in the Serial Number table (and not in the server CI attribute).
  - If the system serial number is available, store it in both the **Serial Number** attribute of the CI and in the Serial Number table.

The Serial Number table is a many to one relationship linking back to the server CI. This table has a type field for specifying the type of the serial number (system, uuid, chassis, bios, or baseboard) and...
storing the actual value itself. Use the following Windows standards for serial number types in the Serial Number [cmdb_serial_number] table:

- **system**: Product identification such as a serial number for software, a die number on a hardware chip, or a project number (for noncommercial products).
- **uuid**: Universally unique identifier (UUID) for the product. A UUID is a 128-bit identifier that is guaranteed to be different from other generated UUIDs.
- **chassis**: Manufacturer-allocated number that is used to identify a physical element. Value is the Serial Number member of the System Enclosure or Chassis structure in the SMBIOS information. This type represents the properties associated with a physical system enclosure.
- **bios**: The assigned serial number of the BIOS. This type represents the attributes of the computer system basic input/output services (BIOS) that are installed on the computer.
- **baseboard**: Manufacturer-allocated number that is used to identify the physical element. This property is inherited from CIM_PhysicalElement, and is sometimes referred to as the ‘Motherboard Serial Number’.

**Network adapter:**

- Use the Network Adapter [cmdb_ci_network_adapter] class to store network adapters.
- Set the **Name** attribute in the Network Adapter class to be the name of the Network Adapter device (such as eth0, eth1).
- Set the **MAC Address** attribute to be the MAC address value. Format the string with colon separators between octets and lower case hexadecimal characters with padded zeros.
  
  For example: ‘f8:f2:1e:00:d4:66’
- In the CI Relationship [cmdb_rel_ci] table, create an **Owned By::Owns** relationship to the associated Hardware CI. Specify a reference from the Network Adapter [cmdb_ci_network_adapter] table using the CI with a reference to the associated Hardware CI.

**IP address:**

- Use the IP Address [cmdb_ci_ip_address] class to store IP addresses.
- Store an IP address value in the **IP Address** attribute, and in the **Name** attribute (to avoid empty **Name** attributes).
- Store an IPv4 IP address value using the format 'NNN.NNN.NNN.NNN', with decimal-based octets and period separators. Non-conforming values should be considered invalid and cleansed to null values.
- Store an IPv6 IP address value using lower case hexadecimal with colon separators. Non-confirming values should be considered invalid and cleansed to null values.
- Set the **Netmask** attribute to the IP address.
- In the CI Relationship [cmdb_rel_ci] table, create an **Owned By::Owns** relationship to the associated Hardware hierarchy CI.
- Specify for the IP address a reference to the Network Adapter [cmdb_ci_network_adapter] table using the Configuration Item with a reference to the associated Hardware CI.
- To ensure that base system identification rules work properly, also store the IP address in the associated Network Adapter class.

**Network adapter and IP address:**

- Store the MAC address of the network adapter installed on a server, in the Network Adapter [cmdb_ci_network_adapter] class.
- Store the IP address in the IP Address [cmdb_ci_ip_address] class.
- Do not store the MAC address or the IP address in the Server [cmdb_ci_server] class.
Key reference structures

Use the following key references as important guidelines when creating Hardware, Computer, or Server CIs:

- Software and processes running on a server: The Software [cmdb_ci_spkg] class contains the generic software package that is related to the server CI. The cmdb_sw_instance table instantiates each instance of the software package with:
  - One to one reference back to the Server [cmdb_ci_server] class
  - Many to one reference back to the Software class

These references are stored in the Installed on and the Product Name reference attributes respectively.

If either the Software Asset Management Foundation [com.snc.sams] or the Software Asset Management [com.snc.software_asset_management] plugin is installed, then store software details in the Software Installation [cmdb_sam_sw_install] table instead of the cmdb_sw_instance table.

- The Manufacturer and Model ID are reference attributes to the Company [core_company] and Product Model [cmdb_model] tables respectively.
- The Owned By, Assigned To, Managed By, and Supported By are reference attributes to the User [sys_user] table. The Assignment Group and Support Group are reference attributes to the Group [sys_user_group] table.

Identification rule

The base system contains pre-defined identification rules for the Hardware, Computer, and Server classes, which are identical. That identification rule has the following key identifier entries, listed in priority order:

1. Identifier entry which uses lookup-based identification specified with Serial Number [cmdb_serial_number] as the lookup table. The Serial Number table is a many to one reference from Serial Number back to the server CI.
2. Identifier entry specified with the Serial Number attribute in the CI.
3. Identifier entry for the Name attribute. If Serial Number is not available, then the Name (which is the hostname) attribute is used. If both the Serial Number and the Name attributes are provided, then Identification and Reconciliation Engine (IRE) looks first for the Serial Number. Then, if a Serial Number is not found, IRE falls back to using Name.
4. Identifier entry specified for the MAC Address/IP Address attributes in the Network Adapter table. However, do not rely only on the MAC Address/IP Address.

If both Serial Number and Name are not available, and only MAC Address/IP Address are available, use MAC Address as the name of the CI. Using the MAC Address as the name of the CI ensures that you don't create an empty CI.

For more information, see CMDB Identification and Reconciliation.

VMware vCenter Object [cmdb_ci_vcenter_object] class

Attributes, identification rule, and other important schema structures for Virtual Machine related classes.
Schema description

ServiceNow® has an extensive modeling of virtual machines (VMs) environment, with classes such as:

- VMware vCenter Cluster [cmdb_ci_vcenter_cluster]
- VMware vCenter datacenter [cmdb_ci_vcenter_datacenter]
- VMware Virtual Machine Instance [cmdb_ci_vmware_instance]

Virtual machines are modeled just like any other server, but with the `IsVirtual` attribute set to `true`. 
VMWare vCenter Instance schema structure

In the diagram above, the ‘Discovered’ virtual server is referred to as the ‘Guest’ (VM object). Follow the preceding diagram for any further modeling of VMWare components.

**Key reference structures**

The Guest has the following important key reference structures:
• An Instantiates::InstantiatedBy relationship with the cmdb_ci_vmware_instance (which is the VM instance reported by Center).
• A Virtualizes::Virtualized by relationship with ESXi Server (the hardware with the ESXi virtualization software installed).
• Guest (Discovered, VMOBJECT) also has a HasRegistered::RegisteredOn relationship to ESXi Server.

Identification rules

• Guest operating system: Guest operating system is modeled as Server (with IsVirtual set to true) and therefore identification rules follow the rules for the Server class. In most operating systems, BIOS UUID is reported as serial number. It is essential that you follow proper VMware guidelines to ensure that BIOS UUID is not being reused. Having a cloned BIOS UUID causes issues with identification rules.
• VM Instances: IRE uses instance MosRef ID as key identifier.
• ESX Server: Server is modeled as bare metal Server (with IsVirtual set to false) and therefore applies the Server class identification rules.

CMDB CI Class Models store app

Adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. Use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs.

CMDB CI Class Models Release 1.12.0

The CMDB CI Class Models store apps adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships (if applicable). Use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs and discover various technologies and software.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

What’s new in this release

CMDB CI Class Models: Release 1.12.0 adds classes to the following:

• Kubernetes pattern
• Firewalls

Kubernetes pattern

The Kubernetes pattern main flow helps with discovering Kubernetes core elements. The classes in this release, extend the support to discover kubernetes workload controller components like deployments,
daemonsets, and statefulsets. The Workload Share library captures information about deployments, daemonsets, and statefulsets and stores them in the respective tables. Other extensions include YAML and service mesh extension that generates a YAML file to track configuration files and creating service to service relations by discovering service mesh information.

Kubernetes extension class integrated with the CMDB hierarchy

Firewalls

A firewall is a network security system that monitors and controls incoming and outgoing network traffic, based on security policies. Firewalls typically form a barrier between an internal network and an untrusted external network, such as the internet. It usually consists of security policies that help secure an organization from external threats and cyber attacks. Firewall vendors may provide a centralized firewall manager to manage many firewall devices and the security policies residing on them. For example, Panorama™ is the centralized management system for Palo Alto Networks firewalls.

The ServiceNow Discovery application uses the following patterns for the discovery of firewall devices:

- #unique_176
- #unique_177
- #unique_178
- #unique_179
Firewall extension classes integrated with the CMDB class hierarchy.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Classes

This section lists the classes that the CMDB CI Class Models store app adds or updates.

CMDB CI Class Models: Release 1.12.0 adds the following classes for Kubernetes pattern:

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Fields</th>
<th>Relation</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmdb_ci_kubernetes_work</td>
<td>cmdb_ci_kubernetes_component</td>
<td>'Provides' from cmdb_ci_kubernetes_service</td>
<td></td>
</tr>
<tr>
<td>cmdb_ci_kubernetes_deployment</td>
<td>cmdb_ci_kubernetes_workload</td>
<td>Replicas Desired • Replicas Updated • Replicas Total • Replicas Available • Replicas Unavailable</td>
<td>Hosted on Cluster</td>
</tr>
<tr>
<td>cmdb_ci_kubernetes_daemonset</td>
<td>cmdb_ci_kubernetes_workload</td>
<td>Pods running • Pods Waiting • Pods Succeeded • Pods Failed • Pods Available</td>
<td>Hosted on Cluster</td>
</tr>
<tr>
<td>cmdb_ci_kubernetes_statefulset</td>
<td>cmdb_ci_kubernetes_workload</td>
<td>Replicas Desired • Replicas Updated • Replicas Total • Replicas Available • Replicas Unavailable</td>
<td>Hosted on Cluster</td>
</tr>
</tbody>
</table>

The CMDB CI Class Models store app adds the following class for the discovery of firewall devices.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Firewall Device</td>
<td>[cmdb_ci_firewall_device_cisco]</td>
<td>All Cisco Firewall devices.</td>
</tr>
<tr>
<td>[cmdb_ci_firewall_device]</td>
<td>[cmdb_ci_firewall_device]</td>
<td></td>
</tr>
</tbody>
</table>

Class columns

The CMDB CI Class Models store app adds no columns to the existing classes.

CMDB CI Class Models: Release 1.10.0

The CMDB CI Class Models store app adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships (if applicable). Use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs and discover various technologies and software.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

What's new in this release

CMDB CI Class Models: Release 1.10.0 adds classes for the following:

- Firewalls
- VMware NSX load balancers

Firewalls

A firewall is a network security system that monitors and controls incoming and outgoing network traffic, based on security policies. Firewalls typically form a barrier between an internal network and an untrusted external network, such as the internet. It usually consists of security policies that help secure an organization from external threats and cyber attacks. Firewall vendors may provide a centralized firewall manager to manage many firewall devices and the security policies residing on them. For example, Panorama™ is the centralized management system for Palo Alto Networks firewalls.
Firewall extension classes integrated with the CMDB class hierarchy.
VMware NSX load balancers

NSX is a network virtualization solution offered by VMware. Among the virtual resources included in the NSX solution are virtual LANs (VLANs), virtual load balancers, virtual routers, switches, and firewalls.

ServiceNow Discovery uses the #unique_181 pattern to find VMware NSX load balancers and their components: Listeners, pools, pool members, and health services.

VMware NSX load balancer classes integrated with the CMDB class hierarchy

Classes

This section lists the classes that the CMDB CI Class Models store app adds or updates.

CMDB CI Class Models: Release 1.10.0 adds the following classes for the discovery of network firewall devices.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Extends</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Firewall Device [cmdb_ci_firewall_device]</td>
<td>IP Firewall [cmdb_ci_ip_firewall]</td>
<td>Network security system that monitors and controls incoming and outgoing network traffic, based on security policies.</td>
</tr>
<tr>
<td>cmdb_ci_firewall_device_fortinet</td>
<td>cmdb_ci_firewall_device</td>
<td>Fortinet firewall device.</td>
</tr>
<tr>
<td>cmdb_ci_firewall_device_juniper</td>
<td>cmdb_ci_firewall_device</td>
<td>Juniper firewall device.</td>
</tr>
<tr>
<td>Firewall Device Group [cmdb_ci_firewall_device_group]</td>
<td>CMDB CI [cmdb_ci]</td>
<td>Group of firewall devices.</td>
</tr>
<tr>
<td>Panorama Firewall Device Group [cmdb_ci_firewall_device_group_panorama]</td>
<td>Firewall Device Group [cmdb_ci_firewall_device_group]</td>
<td>Group of Panorama firewall devices.</td>
</tr>
<tr>
<td>Palo Alto Firewall Device [cmdb_ci_firewall_device_palo_alto]</td>
<td>Firewall Device [cmdb_ci_firewall_device]</td>
<td>Palo Alto firewall device.</td>
</tr>
<tr>
<td>Firewall Cluster [cmdb_ci_firewall_cluster]</td>
<td>cmdb_ci_cluster</td>
<td>Group of firewall nodes that work as a single logical entity.</td>
</tr>
<tr>
<td>Fortinet Firewall Cluster [cmdb_ci_firewall_cluster_fortinet]</td>
<td>cmdb_ci_firewall_cluster</td>
<td>Fortinet firewall cluster.</td>
</tr>
<tr>
<td>Juniper Firewall Cluster [cmdb_ci_firewall_cluster_juniper]</td>
<td>cmdb_ci_firewall_cluster</td>
<td>Juniper firewall cluster.</td>
</tr>
<tr>
<td>Firewall Manager [cmdb_ci_firewall_manager]</td>
<td>CMDB CI [cmdb_ci]</td>
<td>System that provides centralized management for many firewall devices and the security policies residing on them.</td>
</tr>
<tr>
<td>Panorama Firewall Manager [cmdb_ci_firewall_manager_panorama]</td>
<td>Firewall Manager [cmdb_ci_firewall_manager]</td>
<td>The centralized network security management tool for Palo Alto Networks firewalls.</td>
</tr>
<tr>
<td>Firewall Security Policy [cmdb_ci_firewall_sec_policy]</td>
<td>CMDB CI [cmdb_ci]</td>
<td>The security policy that the firewall device enforces.</td>
</tr>
<tr>
<td>Panorama Firewall Security Policy [cmdb_ci_firewall_sec_policy_panorama]</td>
<td>Firewall Security Policy [cmdb_ci_firewall_sec_policy]</td>
<td>The security policy that the Panorama firewall device enforces.</td>
</tr>
</tbody>
</table>

CMDB CI Class Models: Release 1.10.0 adds the following classes for the VMware NSX load balancer.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NSX Load Balancer [cmdb_ci_nsx_lb]</td>
<td>Load Balancer [cmdb_ci_lb]</td>
<td>The table containing the NSX Load Balancer resources.</td>
</tr>
</tbody>
</table>

Class columns

CMDB CI Class Models: Release 1.10.0 adds the following columns to the respective classes for the discovery of network firewall devices.
IP Firewall [cmdb_ci_ip_firewall] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Operating System</td>
<td>OS running on the hardware.</td>
</tr>
<tr>
<td>Hardware OS Version</td>
<td>OS version running on the hardware.</td>
</tr>
</tbody>
</table>

Firewall Cluster [cmdb_ci_firewall_cluster]

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Operating System</td>
<td>OS running on the hardware.</td>
</tr>
<tr>
<td>Hardware OS Version</td>
<td>OS version running on the hardware.</td>
</tr>
</tbody>
</table>

The #unique_181 pattern introduces one new table with one identification rule and entry. The table uses only the columns inherited from its parent.

CMDB CI Class Models: Release 1.8.0

The CMDB CI Class Models store app adds class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. Use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs and discover various technologies and software.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

What's new in this release

CMDB CI Class Models: Release 1.8.0 adds classes for the following:

- OpenStack

OpenStack

OpenStack is a cloud operating system that controls large pools of compute, storage, and networking resources throughout a datacenter. All of these resources are managed and provisioned through APIs with common authentication mechanisms. Other components provide services such as orchestration, fault management, and service management to ensure high availability of user applications. OpenStack is broken up into services to enable you to plug and play components depending on your needs. These components are designed for horizontal scalability, so you can easily add new resources to grow your cloud over time.
### Classes

The CMDB CI Class Models store app adds or updates the following classes.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpenStack Services</td>
<td>[cmdb_ci_cloud_openstack_service]</td>
<td>Virtual Machine Object [cmdb_ci_vm_object] An OpenStack web service that can be accessed via a URL.</td>
</tr>
</tbody>
</table>

### Class Columns

The CMDB CI Class Models store app adds the following columns to the relevant classes.

**OpenStack Services** [cmdb_ci_cloud_openstack_service] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>The Service type, which describes the API implemented by the Service. Possible values: Compute, ec2, identity, image, network, or volume.</td>
</tr>
<tr>
<td>enabled</td>
<td>Defines if the service and its endpoints appear in the Service catalog (true/false).</td>
</tr>
</tbody>
</table>

**OpenStack Endpoint** [cmdb_ci_cloud_openstack_endpoint] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>interface</td>
<td>The interface type, which describes the visibility of the endpoint. Possible values:</td>
</tr>
<tr>
<td></td>
<td>• public - Visible by end users on a publicly available network interface.</td>
</tr>
<tr>
<td></td>
<td>• internal - Visible by end users on an unmetered internal network interface.</td>
</tr>
<tr>
<td></td>
<td>• admin - Visible by administrative users on a secure network interface.</td>
</tr>
<tr>
<td>enabled</td>
<td>Defines if the Service and its endpoints appear in the Service catalog (true/false).</td>
</tr>
</tbody>
</table>

**OpenStack Domain** [cmdb_ci_cloud_openstack_domain] class

<table>
<thead>
<tr>
<th>Added columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>enabled</td>
<td>Defines if the domain is enabled (true/false).</td>
</tr>
</tbody>
</table>
CMDB CI Class Models: Release 1.6.0

Add class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. Use the added classes as any other CMDB class. Applications such as Service Mapping patterns and Discovery can use these class extensions to populate CIs.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

Use extension classes

The CMDB CI Class Models app adds classes, columns, and the associated metadata, as related records in the following tables:

- **CMDB Class Information [cmdb_class_info]**: Class descriptions
- **Identifier [cmdb_identifier]**: Identification rules
- **Identifier Entry [cmdb_identifier_entry]**: Identification entries
- **CMDB Metadata Hosting Rules [cmdb_metadata_hosting]**: Dependent relationships

After installation, navigate to **Configuration** and then click **CI Class Manager**. Then click **Hierarchy** in CI Class Manager to display the CI Classes list. This list contains the added classes, such as the Nutanix classes. Select a class to see the corresponding class details, identification rules, identifier entries, and dependent relationships if applicable.

Use extension classes as any other CMDB class. Applications such as Service Mapping and Discovery can use these class extensions to discover various technologies and software such as the Nutanix Enterprise Cloud software.

**Note:** Uninstalling the CMDB CI Class Models application might compromise the integrity of the CMDB and result in unexpected behavior.

Internet of Things (IoT)

IoT is a system of interrelated computing devices, mechanical and digital machines, objects, animals or people that are provided with unique identifiers and the ability to transfer data over a network without requiring human-to-human or human-to-computer interaction. The classes added in this release, extend the Data Model to provide a foundation for the representation of IoT CI classes. This foundation underpins workflows for Enterprise Asset Management (EAM), Governance Risk Compliance (GRC), Component Supply Management (CSM), and Field Service Management (FSM) surrounding the management of IoT devices and the transport vehicles that some reside in.
IoT extension classes integrated with the CMDB class hierarchy.

AVI Load Balancer

The Avi Vantage platform is built on software-defined principles, enabling a next generation architecture to deliver the flexibility and simplicity expected by IT and lines of business. The Avi Vantage platform...
architecture separates the data and control planes to deliver application services beyond load balancing, such as application analytics, predictive autoscaling, and self-service, for app owners in on-premises or cloud environments. The platform provides a centrally managed, dynamic pool of load balancing resources on commodity x86 servers, virtual machines, or containers, to deliver granular services close to individual applications. Providing these services allows network services to scale near infinitely without the added complexity of managing hundreds of disparate appliances.
Avi load balancer classes integrated with the CMDB class hierarchy
## Classes

The CMDB CI Class Models store app adds or updates the following classes. See the respective class section for further details.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transport Type</td>
<td>cmdb_ci</td>
<td>Types of transportation that contain interconnected technology.</td>
</tr>
<tr>
<td>[cmdb_ci_transport]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Converged Infrastructure</td>
<td>cmdb_ci_hardware</td>
<td>Devices that serve both computing and networking functions.</td>
</tr>
<tr>
<td>[cmdb_ci_converged_infra]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IoT Device</td>
<td>cmdb_ci_hardware</td>
<td>Parent table that contains Internet of Things device types.</td>
</tr>
<tr>
<td>[cmdb_ci_IoT]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aircraft</td>
<td>Transport Type</td>
<td>A transportation method that utilizes air or space as its primary pathway.</td>
</tr>
<tr>
<td>[cmdb_ci_aircraft]</td>
<td>[cmdb_ci_transport]</td>
<td>For example, airplanes and helicopters.</td>
</tr>
<tr>
<td>Ship</td>
<td>Transport Type</td>
<td>A transportation method that utilizes water as its primary pathway.</td>
</tr>
<tr>
<td>[cmdb_ci_ship]</td>
<td>[cmdb_ci_transport]</td>
<td>For example, ships.</td>
</tr>
<tr>
<td>Train</td>
<td>Transport Type</td>
<td>A transportation method that utilizes rails as its primary pathway.</td>
</tr>
<tr>
<td>[cmdb_ci_train]</td>
<td>[cmdb_ci_transport]</td>
<td>For example, Amtrak.</td>
</tr>
<tr>
<td>Vehicle</td>
<td>Transport Type</td>
<td>A transportation method that utilizes wheels or tracks as its method of</td>
</tr>
<tr>
<td>[cmdb_ci_vehicle]</td>
<td>[cmdb_ci_transport]</td>
<td>movement. For example, cars, trucks, bulldozers.</td>
</tr>
<tr>
<td>IoT Gateway</td>
<td>Converged Infrastructure</td>
<td>A device that provides the following services:</td>
</tr>
<tr>
<td>[cmdb_ci_IoT_gateway]</td>
<td>[cmdb_ci_converged_infra]</td>
<td>• Forwards packets between LAN and WAN on the IP layer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Performs application layer functions between IoT nodes and other</td>
</tr>
<tr>
<td></td>
<td></td>
<td>entities.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Enables local, short-range communication between IoT devices.</td>
</tr>
<tr>
<td>Security Device</td>
<td>IoT Device</td>
<td>Connected device that serves a security function such as badge readers.</td>
</tr>
<tr>
<td>[cmdb_ci_security]</td>
<td>[cmdb_ci_IoT]</td>
<td></td>
</tr>
<tr>
<td>Single Board Computing</td>
<td>IoT Device</td>
<td>Single Board Computing device such as a Raspberry Pi.</td>
</tr>
<tr>
<td>[cmdb_ci_sbc]</td>
<td>[cmdb_ci_IoT]</td>
<td></td>
</tr>
<tr>
<td>Display Device</td>
<td>IoT Device</td>
<td>Connected device that displays images.</td>
</tr>
<tr>
<td>[cmdb_ci_display]</td>
<td>[cmdb_ci_IoT]</td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Extends</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Imaging Device</td>
<td>IoT Device</td>
<td>Connected device that captures images.</td>
</tr>
<tr>
<td>[cmdb_ci_imaging]</td>
<td>[cmdb_ci_IoT]</td>
<td></td>
</tr>
<tr>
<td>Medical Device</td>
<td>IoT Device</td>
<td>Connected device that serves a Medical Care function such as a nurse call unit.</td>
</tr>
<tr>
<td>[cmdb_ci_medical]</td>
<td>[cmdb_ci_IoT]</td>
<td></td>
</tr>
<tr>
<td>Manufacturing Device</td>
<td>IoT Device</td>
<td>Connected device that helps a manufacturing process.</td>
</tr>
<tr>
<td>[cmdb_ci_manufacturing]</td>
<td>[cmdb_ci_IoT]</td>
<td></td>
</tr>
<tr>
<td>Multimedia Device</td>
<td>IoT Device</td>
<td>A connected device that helps the generation or delivery of media content.</td>
</tr>
<tr>
<td>[cmdb_ci_multimedia]</td>
<td>[cmdb_ci_IoT]</td>
<td></td>
</tr>
<tr>
<td>Payment Device</td>
<td>IoT Device</td>
<td>Connected device that allows for purchasing goods or services.</td>
</tr>
<tr>
<td>[cmdb_ci_payment]</td>
<td>[cmdb_ci_IoT]</td>
<td></td>
</tr>
<tr>
<td>Drone</td>
<td>IoT Device</td>
<td>Unmanned connected device with mobility.</td>
</tr>
<tr>
<td>[cmdb_ci_drone]</td>
<td>[cmdb_ci_IoT]</td>
<td></td>
</tr>
<tr>
<td>Wearable Technology</td>
<td>IoT Device</td>
<td>Connected device that is worn by an entity such as a smart watch.</td>
</tr>
<tr>
<td>[cmdb_ci_wearable]</td>
<td>[cmdb_ci_IoT]</td>
<td></td>
</tr>
<tr>
<td>Smart Television</td>
<td>Display Device</td>
<td>A television that is network connected and can run applications.</td>
</tr>
<tr>
<td>[cmdb_ci_stv]</td>
<td>[cmdb_ci_display]</td>
<td></td>
</tr>
<tr>
<td>IP Camera</td>
<td>Imaging Device</td>
<td>A camera that is network connected.</td>
</tr>
<tr>
<td>[cmdb_ci_ip_camera]</td>
<td>[cmdb_ci_imaging]</td>
<td></td>
</tr>
<tr>
<td>Medical Measuring Device</td>
<td>Medical Device</td>
<td>A device that is network connected which takes medical measurements such as the Abbott iStat System.</td>
</tr>
<tr>
<td>[cmdb_ci_med_measuring]</td>
<td>[cmdb_ci_medical]</td>
<td></td>
</tr>
<tr>
<td>Medical Diagnostic Device</td>
<td>Medical Device</td>
<td>A medical diagnostic device that is network connected, such as a CT system.</td>
</tr>
<tr>
<td>[cmdb_ci_med_diagnostic]</td>
<td>[cmdb_ci_medical]</td>
<td></td>
</tr>
<tr>
<td>Medical Monitoring Device</td>
<td>Medical Device</td>
<td>A device that is network connected which is used to monitor medical patients. For example, the Phillips Patient Monitoring System.</td>
</tr>
<tr>
<td>[cmdb_ci_med_monitoring]</td>
<td>[cmdb_ci_medical]</td>
<td></td>
</tr>
<tr>
<td>Medical Therapeutic Device</td>
<td>Medical Device</td>
<td>A device that is network connected which provides medical patient therapy. For example, the Compex Muscle Stimulator.</td>
</tr>
<tr>
<td>[cmdb_ci_med_therapeutic]</td>
<td>[cmdb_ci_medical]</td>
<td></td>
</tr>
<tr>
<td>Medical Support Device</td>
<td>Medical Device</td>
<td>A device that is network connected that helps deliver medical care. For example, the Pyxis MedStation.</td>
</tr>
<tr>
<td>[cmdb_ci_med_support]</td>
<td>[cmdb_ci_medical]</td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Extends</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Process Logic Controller</td>
<td>Manufacturing Device</td>
<td>A logic controller that is network connected which is used in manufacturing. For example, devices made by Siemens and Allen Bradley.</td>
</tr>
<tr>
<td>[cmdb_ci_plc]</td>
<td>[cmdb_ci_manufacturing]</td>
<td></td>
</tr>
<tr>
<td>Human Machine Interface</td>
<td>Manufacturing Device</td>
<td>An HMI that is network connected which is used in manufacturing. For example, devices made by Siemens and Allen Bradley.</td>
</tr>
<tr>
<td>[cmdb_ci_hmi]</td>
<td>[cmdb_ci_manufacturing]</td>
<td></td>
</tr>
<tr>
<td>Game Console</td>
<td>Multimedia Device</td>
<td>A device that is network connected which is used to play games or stream media. For example, an Xbox or Playstation.</td>
</tr>
<tr>
<td>[cmdb_ci_game_console]</td>
<td>[cmdb_ci_multimedia]</td>
<td></td>
</tr>
<tr>
<td>Media Player</td>
<td>Multimedia Device</td>
<td>A device that is network connected which is used to play digital media content. For example, Amazon Fire TV.</td>
</tr>
<tr>
<td>[cmdb_ci_media_player]</td>
<td>[cmdb_ci_multimedia]</td>
<td></td>
</tr>
<tr>
<td>Display Monitor Control</td>
<td>Multimedia Device</td>
<td>A device that is network connected that controls the display of media on a monitor. For example, a Crestron Media Controller.</td>
</tr>
<tr>
<td>[cmdb_ci_monitor_control]</td>
<td>[cmdb_ci_multimedia]</td>
<td></td>
</tr>
<tr>
<td>Point of Sale Device</td>
<td>Payment Device</td>
<td>A device that is network connected which is used in the purchase of goods or services. For example, a credit card reader.</td>
</tr>
<tr>
<td>[cmdb_ci_pos]</td>
<td>[cmdb_ci_payment]</td>
<td></td>
</tr>
<tr>
<td>AVI Controller</td>
<td>Virtual Machine Object</td>
<td>Avi Controller is a single point of management and control that is the 'brain' of the entire Avi Vantage system, and typically deployed as a redundant three-node cluster.</td>
</tr>
<tr>
<td>[cmdb_ci_avi_controller]</td>
<td>[cmdb_ci_vm_object]</td>
<td></td>
</tr>
<tr>
<td>AVI Controller Cluster</td>
<td>Virtual Machine Object</td>
<td>Avi Controller cluster uses big data analytics to analyze the data and present actionable insights to administrators on intuitive dashboards on the Avi Admin Console.</td>
</tr>
<tr>
<td>[cmdb_ci_avi_controller_cluster]</td>
<td>[cmdb_ci_vm_object]</td>
<td></td>
</tr>
<tr>
<td>AVI Service Engine</td>
<td>Virtual Machine Object</td>
<td>Avi Service Engines (SEs) handle all data plane operations within Avi Vantage by receiving and executing instructions from the Avi Controller.</td>
</tr>
<tr>
<td>[cmdb_ci_avi_service_engine]</td>
<td>[cmdb_ci_vm_object]</td>
<td></td>
</tr>
<tr>
<td>RHV LDC</td>
<td>Logical Datacenter</td>
<td>RHV logical datacenter.</td>
</tr>
<tr>
<td>[cmdb_ci_rhv_ldc]</td>
<td>[cmdb_ci_logical_datacenter]</td>
<td></td>
</tr>
<tr>
<td>RHV Datacenter</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>[cmdb_ci_rhv_datacenter]</td>
<td>NA</td>
<td>This class is deleted.</td>
</tr>
</tbody>
</table>
Class columns

The CMDB CI Class Models store app adds the following columns to the relevant classes.

<table>
<thead>
<tr>
<th>Added column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>version</td>
<td>The version of the Avi Service Engine resource.</td>
</tr>
</tbody>
</table>

CMDB CI Class Models: Release 1.5.0

Add class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. Use the added classes as any other CMDB class. Applications such as Service Mapping patterns and Discovery can use these class extensions to populate CIs.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

Use extension classes

The CMDB CI Class Models app adds classes, columns, and the associated metadata, as related records in the following tables:

- CMDB Class Information [cmdb_class_info]: Class descriptions
- Identifier [cmdb_identifier]: Identification rules
- Identifier Entry [cmdb_identifier_entry]: Identification entries
- CMDB Metadata Hosting Rules [cmdb_metadata_hosting]: Dependent relationships

After installation, navigate to Configuration and then click CI Class Manager. Then click Hierarchy in CI Class Manager to display the CI Classes list. This list contains the added classes, such as the Nutanix classes. Select a class to see the corresponding class details, identification rules, identifier entries, and dependent relationships if applicable.

Use extension classes as any other CMDB class. Applications such as Service Mapping and Discovery can use these class extensions to discover various technologies and software such as the Nutanix Enterprise Cloud software.

Note: Uninstalling the CMDB CI Class Models application might compromise the integrity of the CMDB and result in unexpected behavior.

Red Hat Virtualization (RHV)

Red Hat Virtualization (RHV) is a virtualization product which is based on the Kernel-based Virtual Machine (KVM) hypervisor. RHV uses the SPICE protocol and Virtual Desktop Server Manager (VDSM) with a RHEL-based centralized management server. RHV solution is based on two primary software components:
Red Hat Virtualization Manager (RHV-M) and Red Hat Virtualization Hypervisors or hosts: Red Hat Enterprise Linux or RHV Host (RHV-H).

### Classes

The CMDB CI Class Models store app adds or updates the following classes. See the respective class section for further details.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RHV Server</td>
<td>Virtualization Server</td>
<td>The RHV virtualization host.</td>
</tr>
<tr>
<td>[cmdb_ci_rhv_server]</td>
<td>[cmdb_ci_virtualization_server]</td>
<td></td>
</tr>
</tbody>
</table>
### RHV Server

The CMDB CI Class Models store app adds the following columns to the RHV Server [cmdb_ci_rhv_server] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>url</td>
<td>URL used to access the object.</td>
</tr>
</tbody>
</table>

### RHV Object

The CMDB CI Class Models store app adds the following columns to the RHV Object [cmdb_ci_rhv_object] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>href_id</td>
<td>Href ID.</td>
</tr>
<tr>
<td>manager_id</td>
<td>Manager ID.</td>
</tr>
<tr>
<td>url</td>
<td>URL to access the object (used in child classes).</td>
</tr>
</tbody>
</table>

### RHV Manager

The CMDB CI Class Models store app adds the following columns to the RHV Manager [cmdb_ci_rhv_manager] class.
<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>url</td>
<td>URL of the manager.</td>
</tr>
<tr>
<td>product_name</td>
<td>Product name.</td>
</tr>
</tbody>
</table>

**RHV Cluster**

The CMDB CI Class Models store app adds the following columns to the RHV Cluster [cmdb_ci_rhv_cluster] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cpu_type</td>
<td>CPU type.</td>
</tr>
<tr>
<td>cpu_architecture</td>
<td>CPU architecture.</td>
</tr>
<tr>
<td>ksm</td>
<td>Enabled state of kernel same-page merging (KSM) memory policy.</td>
</tr>
<tr>
<td>fencing_policy</td>
<td>Fencing policy.</td>
</tr>
<tr>
<td>memory_overcommitment</td>
<td>Amount of over-commitment memory allowed on the cluster.</td>
</tr>
<tr>
<td>transparenthuge_pages</td>
<td>Transparent huge memory pages policy.</td>
</tr>
<tr>
<td>ballooning</td>
<td>Memory ballooning for guests.</td>
</tr>
<tr>
<td>compatibility_version</td>
<td>Compatibility version.</td>
</tr>
</tbody>
</table>

**RHV Datacenter**

The CMDB CI Class Models store app adds the following columns to the RHV Datacenter [cmdb_ci_rhv_datacenter] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>quota_mode</td>
<td>Quota mode policy.</td>
</tr>
</tbody>
</table>

**RHV Virtual Machine Instance**

The CMDB CI Class Models store app adds the following columns to the RHV Virtual Machine Instance [cmdb_ci_rhv_vm_instance] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mgmt_url</td>
<td>Management URL.</td>
</tr>
<tr>
<td>cpu_architecture</td>
<td>CPU architecture.</td>
</tr>
<tr>
<td>delete_protected</td>
<td>Delete protected (true/false).</td>
</tr>
<tr>
<td>ha_priority</td>
<td>HA priority.</td>
</tr>
<tr>
<td>high_availability</td>
<td>High availability (true/false).</td>
</tr>
<tr>
<td>Columns (added)</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>memory_policy_guaranteed</td>
<td>Amount of memory guaranteed (MB).</td>
</tr>
<tr>
<td>memory_policy_max_mb</td>
<td>Maximum memory in the dynamic memory allocation policy.</td>
</tr>
<tr>
<td>multi_queues</td>
<td>Multi queues.</td>
</tr>
<tr>
<td>placement_policy</td>
<td>Placement policy.</td>
</tr>
<tr>
<td>cpu.Sockets</td>
<td>Number of CPU sockets.</td>
</tr>
<tr>
<td>stateless</td>
<td>Stateless (true/false).</td>
</tr>
<tr>
<td>storage_error_resume_behaviour</td>
<td>Behavior of a virtual machine that is paused due to storage I/O error. For examples, AUTO_RESUME, LEAVE_PAUSED, and KILL.</td>
</tr>
<tr>
<td>start_time</td>
<td>Start time.</td>
</tr>
<tr>
<td>stop_time</td>
<td>Stop time.</td>
</tr>
<tr>
<td>threads</td>
<td>Number of threads.</td>
</tr>
<tr>
<td>time_zone</td>
<td>Time zone.</td>
</tr>
<tr>
<td>usb</td>
<td>USB enabled state.</td>
</tr>
<tr>
<td>run_once</td>
<td>Run once.</td>
</tr>
<tr>
<td>type</td>
<td>RHV type.</td>
</tr>
</tbody>
</table>

**Nutanix Prism Central**

The Nutanix Prism Central [cmdb_ci_nutanix_prism_central] class has no added columns.

**CMDB CI Class Models: Release 1.4.0**

Add class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. Use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**Use extension classes**

The CMDB CI Class Models app adds classes, columns, and the associated metadata, as related records in the following tables:

- CMDB Class Information [cmdb_class_info]: Class descriptions
- Identifier [cmdb_identifier]: Identification rules
After installation, navigate to Configuration and then click CI Class Manager. Then click Hierarchy in CI Class Manager to display the CI Classes list. This list contains the added classes, such as the Nutanix classes. Select a class to see the corresponding class details, identification rules, identifier entries, and dependent relationships if applicable.

Use extension classes as any other CMDB class. Applications such as Service Mapping and Discovery can use these class extensions to discover various technologies and software such as the Nutanix Enterprise Cloud software.

**Note:** Uninstalling the CMDB CI Class Models application might compromise the integrity of the CMDB and result in unexpected behavior.

### Classes

The CMDB CI Class Models store app updates the following class. See the class section for further details about the updates.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unique Certificate</td>
<td>Configuration Item</td>
<td>A public key certificate in X.509 standard format.</td>
</tr>
<tr>
<td>[cmdb_ci_certificate]</td>
<td>[cmdb_ci]</td>
<td></td>
</tr>
</tbody>
</table>

### Unique Certificate

The CMDB CI Class Models store app changes the Unique Certificate [cmdb_ci_certificate] class as follows:

- The assigned_to attribute now depends on the assignment_group attribute so that users in the assigned_to attribute are filtered based on the specified assignment_group.
- You can no longer add new records to the Unique Certificate [cmdb_ci_certificate] class. The list view for that class does not have a New button.
- You can no longer add or delete attachments in the Certificate file attribute.

### CMDB CI Class Models: Release 1.3.0

Add class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. Use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs.

### Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.
Use extension classes

The CMDB CI Class Models app adds the classes and columns and the metadata associated with each class as related records in the following tables:

- CMDB Class Information [cmdb_class_info]: Class descriptions
- Identifier [cmdb_identifier]: Identification rules
- Identifier Entry [cmdb_identifier_entry]: Identification entries
- CMDB Metadata Hosting Rules [cmdb_metadata_hosting]: Dependent relationships

After installation, navigate to Configuration and then click CI Class Manager. When you click Hierarchy in CI Class Manager, the CI Classes list contains the added classes such as the Nutanix classes. Select a class to see its corresponding class details, identification rules, identifier entries, and dependent relationships if applicable.

Use extension classes as any other CMDB class. Applications such as Service Mapping and Discovery can use these class extensions to discover various technologies and software such as the Nutanix Enterprise Cloud software.

Note: Uninstalling the CMDB CI class models application might compromise the integrity of the CMDB and result in unexpected behavior.

Scoped apps certification classes

The scoped apps certification classes support certification of scoped apps. With these classes you can proactively manage certificates by keeping stakeholders informed about any impending expiries. Use these extension classes to ensure that certificates are monitored and renewed before they expire, to prevent severe outage of production systems.

Classes

The CMDB CI Class Models store app adds or updates (by adding new columns) the following classes. See each respective class section for further details about the columns added for each class.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unique Certificate</td>
<td>Configuration Item</td>
<td>N/A</td>
</tr>
<tr>
<td>[cmdb_ci_certificate]</td>
<td>[cmdb_ci]</td>
<td></td>
</tr>
<tr>
<td>Certificate Domain</td>
<td>N/A</td>
<td>Fully qualified domain name.</td>
</tr>
<tr>
<td>[certificate_domain]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM Frame</td>
<td>Server</td>
<td>IBM physical machine with considerable resources which can be virtualized.</td>
</tr>
<tr>
<td>[cmdb_ci_ibm_frame]</td>
<td>[cmdb_ci_server]</td>
<td></td>
</tr>
<tr>
<td>IBM HMC Processor pool</td>
<td>Virtual Machine Object</td>
<td>IBM shared pool used to allocate processors to a group of LPARs.</td>
</tr>
<tr>
<td>[cmdb_ci_processor_pool]</td>
<td>[cmdb_ci_vm_object]</td>
<td></td>
</tr>
</tbody>
</table>
Unique Certificate

The CMDB CI Class Models store app adds the following columns to the Unique Certificate [cmdb_ci_certificate] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate file</td>
<td>Certificate in an encoded form.</td>
</tr>
<tr>
<td>Fingerprint</td>
<td>Hash value of the certificate.</td>
</tr>
<tr>
<td>Fingerprint algorithm</td>
<td>Algorithm used to hash the certificate.</td>
</tr>
<tr>
<td>Is certificate authority</td>
<td>Indicates whether a certificate is a Certificate Authority (CA) or not.</td>
</tr>
<tr>
<td>Is selfsigned</td>
<td>Indicates whether the certificate is self-signed or not.</td>
</tr>
<tr>
<td>Issuer</td>
<td>Entity that has signed and issued the certificate.</td>
</tr>
<tr>
<td>Reference: Unique Certificate [cmdb_ci_certificate]</td>
<td></td>
</tr>
<tr>
<td>Issuer common name</td>
<td>Common name of the issuer.</td>
</tr>
<tr>
<td>Issuer distinguished name</td>
<td>Distinguished name of the issuer.</td>
</tr>
<tr>
<td>Key size</td>
<td>Size of the key used by the signing algorithm.</td>
</tr>
<tr>
<td>Choices:</td>
<td></td>
</tr>
<tr>
<td>• Create priority 1 tasks</td>
<td></td>
</tr>
<tr>
<td>• Create priority 3 tasks</td>
<td></td>
</tr>
<tr>
<td>• Do not create renewal tasks</td>
<td></td>
</tr>
<tr>
<td>Renewal tracking</td>
<td>Indicates whether to create any priority 1 or priority 3 tasks for the expiring certificates.</td>
</tr>
<tr>
<td>Root issuer</td>
<td>Root entity that has signed and issued the intermediate certificate.</td>
</tr>
<tr>
<td>Choices:</td>
<td></td>
</tr>
<tr>
<td>• External</td>
<td></td>
</tr>
<tr>
<td>• Internal</td>
<td></td>
</tr>
<tr>
<td>Reference: Unique Certificate [cmdb_ci_certificate]</td>
<td></td>
</tr>
<tr>
<td>Service type</td>
<td>Indicates whether the certificate is used for external or internal services.</td>
</tr>
<tr>
<td>Signature algorithm</td>
<td>The cryptographic algorithm used to sign the certificate.</td>
</tr>
<tr>
<td>Choices:</td>
<td></td>
</tr>
<tr>
<td>• Issued</td>
<td></td>
</tr>
<tr>
<td>• Installed</td>
<td></td>
</tr>
<tr>
<td>• Revoked</td>
<td></td>
</tr>
<tr>
<td>• Retired</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>Lifecycle states of the certificate.</td>
</tr>
</tbody>
</table>
### Certificate Domain

The CMDB CI Class Models store app adds the following column to the Certificate Domain [certificate_domain] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain</td>
<td>Fully qualified domain name.</td>
</tr>
</tbody>
</table>

### IBM Frame

The CMDB CI Class Models store app adds the following columns to the IBM Frame [cmdb_ci_ibm_frame] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current available processor units</td>
<td>Current available processor units.</td>
</tr>
<tr>
<td>Configurable processor units</td>
<td>Configurable processor units.</td>
</tr>
<tr>
<td>Configurable memory units</td>
<td>Configurable memory units.</td>
</tr>
<tr>
<td>Installed processor units</td>
<td>Installed processor units.</td>
</tr>
<tr>
<td>Current available memory units</td>
<td>Current available memory units.</td>
</tr>
<tr>
<td>Installed memory units</td>
<td>Installed memory units.</td>
</tr>
</tbody>
</table>
IBM HMC Processor pool

The CMDB CI Class Models store app adds the following columns to the IBM HMC Processor pool [cmdb_ci_processor_pool] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LPAR IDs</td>
<td>LPAR IDs.</td>
</tr>
<tr>
<td>LPAR names</td>
<td>LPAR names.</td>
</tr>
<tr>
<td>Frame name</td>
<td>Frame name.</td>
</tr>
</tbody>
</table>

CMDB CI Class Models: IBM HMC (Release 1.2.0)

Add class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. Use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

Use extension classes

The CMDB CI Class Models app adds the classes and columns and the metadata associated with each class as related records in the following tables:

- [cmdb_class_info]: Class descriptions
- [cmdb_identifier]: Identification rules
- [cmdb_identifier_entry]: Identification entries
- [cmdb_metadata_hosting]: Dependent relationships

After installation, navigate to Configuration and then click CI Class Manager. When you click Hierarchy in CI Class Manager, the CI Classes list contains the added classes such as the Nutanix classes. Select a class to see its corresponding class details, identification rules, identifier entries, and dependent relationships if applicable.

Use extension classes as any other CMDB class. Applications such as Service Mapping and Discovery can use these class extensions to discover various technologies and software such as the Nutanix Enterprise Cloud software.

Note: Uninstalling the CMDB CI class models application might compromise the integrity of the CMDB and result in unexpected behavior.

IBM Hardware Management Console (HMC)

The IBM HMC extension classes support discovery of IBM virtualization technology by providing:
• Discovery of LPARs/FRAMEs which SAM use cases need.
• Topology data of IBM HMC which event correlation requires.
• Topology data for ITSM use cases such as in frame migration.
IBM HMC extension classes integrated with the CMDB class hierarchy
Nutanix Enterprise Cloud platform

The Nutanix Enterprise Cloud platform is a converged, scale-out compute and storage system that hosts and stores virtual machines. All nodes in a Nutanix cluster share the management of cluster resources. The foundational unit for the cluster is a Nutanix node which runs a standard hypervisor and contains processors, memory, and local storage (SSDs and hard disks). A Nutanix Controller virtual machine runs on each node, enabling the pooling of local storage from all nodes in the cluster.

Classes

The CMDB CI Class Models store app adds the following classes. See each respective class section for further details about the columns added for each class.

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM HMC Server</td>
<td>Server [cmdb_ci_server]</td>
<td>IBM console that manages frames and assigns logical partitions (LPARs) to pools.</td>
</tr>
<tr>
<td>IBM Frame</td>
<td>Server [cmdb_ci_server]</td>
<td>IBM physical machine with considerable resources which can be virtualized.</td>
</tr>
<tr>
<td>IBM LPAR Instance</td>
<td>Virtual Machine Instance</td>
<td>IBM logical partition representing the virtual aspect of the operating system.</td>
</tr>
<tr>
<td>IBM HMC Processor pool</td>
<td>Virtual Machine Object</td>
<td>IBM shared pool used to allocate processors to a group of LPARs.</td>
</tr>
<tr>
<td>Nutanix Cluster</td>
<td>Virtual Machine Object</td>
<td>Cluster comprising of the physical nodes running Nutanix software.</td>
</tr>
<tr>
<td>Nutanix Controller VM</td>
<td>Application [cmdb_ci_appl]</td>
<td>Nutanix controller virtual machine that is present in each node and that provides the storage clustering and management capabilities.</td>
</tr>
<tr>
<td>Nutanix Storage Container</td>
<td>Storage Volume [cmdb_ci_storage_volume]</td>
<td>Subset of Nutanix storage pool used to apply policies such as reserved capacity, replication factor, and storage optimization options.</td>
</tr>
<tr>
<td>Nutanix Storage Pool</td>
<td>Storage Pool [cmdb_ci_storage_pool]</td>
<td>Grouping of physical disks within a Nutanix cluster which is typically used to create physical separation between virtual machines.</td>
</tr>
<tr>
<td>Nutanix Host</td>
<td>Virtualization Server</td>
<td>Physical host on which all the virtual machines run.</td>
</tr>
<tr>
<td>Class</td>
<td>Extends</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Nutanix Virtual Machine Instance</td>
<td>Virtual Machine Instance</td>
<td>A virtual machine that runs on Nutanix infrastructure.</td>
</tr>
</tbody>
</table>

**IBM HMC Server**

The CMDB CI Class Models store app adds the following columns to the IBM HMC Server [cmdb_ci_hmc_server] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame count</td>
<td>Count of frames.</td>
</tr>
</tbody>
</table>

**IBM Frame**

The CMDB CI Class Models store app adds the following columns to the IBM Frame [cmdb_ci_ibm_frame] class.

**IBM LPAR Instance**

The CMDB CI Class Models store app adds the following columns to the IBM LPAR Instance [cmdb_ci_lpar_instance] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is VIO</td>
<td>Flags whether this VM is a (VIO) virtual input/output server in the HMC topology.</td>
</tr>
<tr>
<td>High Watermark VCPU</td>
<td>Peak in the utilization of virtual CPU assigned to during the reporting period.</td>
</tr>
<tr>
<td>Frame Serial Number</td>
<td>Serial number of a frame (frame being a physical machine such as ESX).</td>
</tr>
<tr>
<td>VIO Servers</td>
<td>List of VIO servers.</td>
</tr>
</tbody>
</table>

**LPAR Resource**

The CMDB CI Class Models store app adds the following columns to the LPAR Resource [cmdb_ci_lpar_resource] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node name</td>
<td>Name of the node.</td>
</tr>
<tr>
<td>Partition Name</td>
<td>Name of the partition.</td>
</tr>
<tr>
<td>Partition Number</td>
<td>Number of the partition.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of LPAR Resource.</td>
</tr>
<tr>
<td>Mode</td>
<td>Mode of LPAR Resource.</td>
</tr>
<tr>
<td>Columns (added)</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Entitled Capacity</td>
<td>Allotted capacity granted.</td>
</tr>
<tr>
<td>Partition Group-ID</td>
<td>ID of a group of partitions.</td>
</tr>
<tr>
<td>Shared Pool ID</td>
<td>ID of a pool of shared processors.</td>
</tr>
<tr>
<td>Online Virtual CPUs</td>
<td>A virtual CPU.</td>
</tr>
<tr>
<td>Maximum Memory</td>
<td>Maximum amount of memory.</td>
</tr>
<tr>
<td>Minimum Memory</td>
<td>Minimum amount of memory.</td>
</tr>
<tr>
<td>Variable Capacity Weight</td>
<td>Logical partition processor capacity weight.</td>
</tr>
<tr>
<td>Minimum Capacity</td>
<td>Minimum number of processes.</td>
</tr>
<tr>
<td>Capacity Increment</td>
<td>Increments of process.</td>
</tr>
<tr>
<td>Maximum Physical CPUs in system</td>
<td>Maximum CPUs allotted in system.</td>
</tr>
<tr>
<td>Active Physical CPUs in system</td>
<td>Current CPUs in system.</td>
</tr>
<tr>
<td>Active CPUs in Pool</td>
<td>Number of active CPUs within a pool.</td>
</tr>
<tr>
<td>Shared Physical CPUs in system</td>
<td>Number of shared CPUs within a system.</td>
</tr>
<tr>
<td>Maximum Capacity of Pool</td>
<td>Maximum capacity of processes within a pool.</td>
</tr>
<tr>
<td>Entitled Capacity of Pool</td>
<td>Number of processes that are entitled.</td>
</tr>
<tr>
<td>Unallocated Capacity</td>
<td>Number of free spaces.</td>
</tr>
<tr>
<td>Physical CPU Percentage</td>
<td>Number of CPUs allocated to system.</td>
</tr>
<tr>
<td>Unallocated Weight</td>
<td>At no extra charge resources on instance.</td>
</tr>
<tr>
<td>Desired Virtual CPUs</td>
<td>Target number of virtual CPUs.</td>
</tr>
<tr>
<td>Desired Memory</td>
<td>Target amount of memory.</td>
</tr>
<tr>
<td>Desired Variable Capacity Weight</td>
<td>Targeted processor load.</td>
</tr>
<tr>
<td>Desired Capacity</td>
<td>Target resources used within instance.</td>
</tr>
<tr>
<td>High Watermark VCPU</td>
<td>Peak in the utilization of virtual CPU assigned to</td>
</tr>
<tr>
<td></td>
<td>during the reporting period.</td>
</tr>
</tbody>
</table>

**IBM HMC Processor pool**

The CMDB CI Class Models store app adds the following columns to the IBM HMC Processor pool [cmdb_ci_processor_pool] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pool ID</td>
<td>ID of pool of processors.</td>
</tr>
<tr>
<td>CPU Core count</td>
<td>Number of CPU cores.</td>
</tr>
<tr>
<td>Memory count</td>
<td>Amount of memory used.</td>
</tr>
<tr>
<td>Unassigned cores</td>
<td>Number of unused cores.</td>
</tr>
<tr>
<td>Unassigned memory</td>
<td>Amount of unassigned memory.</td>
</tr>
</tbody>
</table>
### Nutanix Cluster

The CMDB CI Class Models store app adds the following columns to the Nutanix Cluster [cmdb_ci_nutanix_cluster] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Serial Numbers</td>
<td>Serial numbers of blocks that are connected to the cluster.</td>
</tr>
<tr>
<td>Cluster ID</td>
<td>UUID (Universal Unique Identifier) of the cluster.</td>
</tr>
<tr>
<td>External Subnet</td>
<td>Subnet of the external IP address of the cluster.</td>
</tr>
<tr>
<td>Full Version</td>
<td>Full version of the cluster.</td>
</tr>
<tr>
<td></td>
<td>For example: el7.3-release-euphrates-5.10.3.1-stable-655d4def34bf18785782f2ad8cdd5f8457d1fe3</td>
</tr>
<tr>
<td>Hypervisor Types</td>
<td>Types of hypervisors that are related to this cluster.</td>
</tr>
<tr>
<td>Internal Subnet</td>
<td>Subnet of internal IP addresses.</td>
</tr>
<tr>
<td>NCC Version</td>
<td>Nutanix cluster check version.</td>
</tr>
<tr>
<td>NTP Servers</td>
<td>NTP servers that are related to this cluster.</td>
</tr>
<tr>
<td>Number of Nodes</td>
<td>Number of nodes that are connected to the cluster.</td>
</tr>
<tr>
<td>Timezone</td>
<td>Timezone of the cluster.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the cluster.</td>
</tr>
<tr>
<td></td>
<td>For example: 5.10.3.1</td>
</tr>
</tbody>
</table>

### Nutanix Controller VM

The CMDB CI Class Models store app adds the following columns to the Nutanix Controller VM [cmdb_ci_nutanix_controller_vm] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hypervisor Type</td>
<td>Type of hypervisor.</td>
</tr>
<tr>
<td>Memory (MB)</td>
<td>Amount of memory (in MB) available on the controller.</td>
</tr>
<tr>
<td>State</td>
<td>On/off power state of controller.</td>
</tr>
<tr>
<td>VM ID</td>
<td>UUID of the controller virtual machine.</td>
</tr>
<tr>
<td>Object ID</td>
<td>ID of the controller virtual machine.</td>
</tr>
</tbody>
</table>

### Nutanix Storage Container

The CMDB CI Class Models store app adds the following columns to the Nutanix Storage Container [cmdb_ci_nutanix_storage_container] class.
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compression</td>
<td>Indicates whether compression is enabled.</td>
</tr>
<tr>
<td>Container ID</td>
<td>UUID of the container.</td>
</tr>
<tr>
<td>Deduplication</td>
<td>Indicates whether on disk deduplication is enabled, that is dedup compression applied to data on hard disks (HDD). Performance tier deduplication is a prerequisite for on disk deduplication.</td>
</tr>
<tr>
<td>Erasure Code</td>
<td>Indicates whether erasure coding is enabled.</td>
</tr>
<tr>
<td>Replication Factor</td>
<td>Number of maintained data copies. The replication factor is specified (2 or 3) when the container is created.</td>
</tr>
</tbody>
</table>

**Nutanix Storage Pool**

The Nutanix Storage Pool [cmdb_ci_nutanix_storage_pool] class has no added columns.

**Nutanix Host**

The Nutanix Host [cmdb_ci_nutanix_host] class has no added columns.

**Nutanix Virtual Machine Instance**

The Nutanix Virtual Machine Instance [cmdb_ci_nutanix_vm_instance] class has no added columns.

**CMDB CI Class Models: Nutanix (Release 1.1.5)**

Add class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. Use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**Nutanix Enterprise Cloud platform**

Use the Nutanix CI class models as any other CMDB class. Applications such as Service Mapping and Discovery can use these class extensions to discover the Nutanix Enterprise Cloud software.

The Nutanix Enterprise Cloud platform is a converged, scale-out compute and storage system that hosts and stores virtual machines. All nodes in a Nutanix cluster share the management of cluster resources. The foundational unit for the cluster is a Nutanix node which runs a standard hypervisor and contains...
processors, memory, and local storage (SSDs and hard disks). A Nutanix Controller virtual machine runs on each node, enabling the pooling of local storage from all nodes in the cluster.

CMDB CI class models adds the classes and columns and the metadata associated with each class as related records in the following tables:

- CMDB Class Information [cmdb_class_info]: Class descriptions
- Identifier [cmdb_identifier]: Identification rules
- Identifier Entry [cmdb_identifier_entry]: Identification entries
- CMDB Metadata Hosting Rules [cmdb_metadata_hosting]: Dependent relationships

### View Nutanix Enterprise Cloud extension classes

After installation, navigate to **Configuration** and then click **CI Class Manager**. When you click **Hierarchy** in CI Class Manager, the CI Classes list contains the added Nutanix classes. Select a class to see its corresponding class details, identification rules, identifier entries, and dependent relationships if applicable.

**Note:** Uninstalling the CMDB CI class models application might compromise the integrity of the CMDB and result in unexpected behavior.

### Classes

The following classes are added:

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nutanix Cluster</td>
<td>Virtual Machine Object</td>
<td>Cluster comprising of the physical nodes running Nutanix software.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_cluster]</td>
<td>[cmdb_ci_vm_object]</td>
<td></td>
</tr>
<tr>
<td>Nutanix Controller VM</td>
<td>Application</td>
<td>Nutanix controller virtual machine that is present in each node and that provides the storage clustering and management capabilities.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_controller_vm]</td>
<td>[cmdb_ci_appl]</td>
<td></td>
</tr>
<tr>
<td>Nutanix Storage Container</td>
<td>Storage Volume</td>
<td>Subset of Nutanix storage pool used to apply policies such as reserved capacity, replication factor, and storage optimization options.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_storage_container]</td>
<td>[cmdb_ci_storage_volume]</td>
<td></td>
</tr>
<tr>
<td>Nutanix Storage Pool</td>
<td>Storage Pool</td>
<td>Grouping of physical disks within a Nutanix cluster which is typically used to create physical separation between virtual machines.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_storage_pool]</td>
<td>[cmdb_ci_storage_pool]</td>
<td></td>
</tr>
<tr>
<td>Nutanix Host</td>
<td>Virtualization Server</td>
<td>Physical host on which all the virtual machines run.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_host]</td>
<td>[cmdb_ci_virtualization_server]</td>
<td></td>
</tr>
<tr>
<td>Nutanix Virtual Machine Instance</td>
<td>Virtual Machine Instance</td>
<td>A virtual machine that runs on Nutanix infrastructure.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_vm_instance]</td>
<td>[cmdb_ci_vm_instance]</td>
<td></td>
</tr>
</tbody>
</table>
### Nutanix Cluster

The following columns are added in the Nutanix Cluster [cmdb_ci_nutanix_cluster] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Serial Numbers</td>
<td>Serial numbers of blocks that are connected to the cluster.</td>
</tr>
<tr>
<td>Cluster ID</td>
<td>UUID (Universal Unique Identifier) of the cluster.</td>
</tr>
<tr>
<td>External Subnet</td>
<td>Subnet of the external IP address of the cluster.</td>
</tr>
<tr>
<td>Full Version</td>
<td>Full version of the cluster. For example: el7.3-release-euphrates-5.10.3.1-stable-655d4def34b18785782f2adb8cdd5f8457d1fe3</td>
</tr>
<tr>
<td>Hypervisor Types</td>
<td>Types of hypervisors that are related to this cluster.</td>
</tr>
<tr>
<td>Internal Subnet</td>
<td>Subnet of internal IP addresses.</td>
</tr>
<tr>
<td>NCC Version</td>
<td>Nutanix cluster check version.</td>
</tr>
<tr>
<td>NTP Servers</td>
<td>NTP servers that are related to this cluster.</td>
</tr>
<tr>
<td>Number of Nodes</td>
<td>Number of nodes that are connected to the cluster.</td>
</tr>
<tr>
<td>Timezone</td>
<td>Timezone of the cluster.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the cluster. For example: 5.10.3.1</td>
</tr>
</tbody>
</table>

### Nutanix Controller VM

The following columns are added in the Nutanix Controller VM [cmdb_ci_nutanix_controller_vm] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hypervisor Type</td>
<td>Type of hypervisor.</td>
</tr>
<tr>
<td>Memory</td>
<td>Amount of memory (in MB) available to the virtual machine.</td>
</tr>
<tr>
<td>State</td>
<td>On/off state of power.</td>
</tr>
<tr>
<td>VM ID</td>
<td>UUID of the controller virtual machine.</td>
</tr>
<tr>
<td>Object ID</td>
<td>ID of the controller virtual machine.</td>
</tr>
</tbody>
</table>

### Nutanix Storage Container

The following columns are added in the Nutanix Storage Container [cmdb_ci_nutanix_storage_container] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compression</td>
<td>Indicates whether compression is enabled.</td>
</tr>
<tr>
<td>Columns (added)</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Container ID</td>
<td>UUID of the container.</td>
</tr>
<tr>
<td>Deduplication</td>
<td>Indicates whether on disk deduplication is enabled, that is dedup compression applied to data on hard disks (HDD). Performance tier deduplication is a prerequisite for on disk deduplication.</td>
</tr>
<tr>
<td>Erasure Code</td>
<td>Indicates whether erasure coding is enabled.</td>
</tr>
<tr>
<td>Replication Factor</td>
<td>Number of maintained data copies. The replication factor is specified (2 or 3) when the container is created.</td>
</tr>
</tbody>
</table>

**Nutanix Storage Pool**

The Nutanix Storage Pool [cmdb_ci_nutanix_storage_pool] class has no added columns.

**Nutanix Host**

The Nutanix Host [cmdb_ci_nutanix_host] class has no added columns.

**Nutanix Virtual Machine Instance**

The Nutanix Virtual Machine Instance [cmdb_ci_nutanix_vm_instance] class has no added columns.

**CMDB CI Class Models: Nutanix (Release 1.1.4)**

Add class models that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier entries, and dependent relationships if applicable. Use the added classes as any other CMDB class. Applications such as Discovery and Service Mapping patterns can use these class extensions to populate CIs.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**Nutanix Enterprise Cloud platform**

Use the Nutanix CI class models as any other CMDB class. Applications such as Service Mapping and Discovery can use these class extensions to discover the Nutanix Enterprise Cloud software.

The Nutanix Enterprise Cloud platform is a converged, scale-out compute and storage system that hosts and stores virtual machines. All nodes in a Nutanix cluster share the management of cluster resources. The foundational unit for the cluster is a Nutanix node which runs a standard hypervisor and contains processors, memory, and local storage (SSDs and hard disks). A Nutanix Controller virtual machine runs on each node, enabling the pooling of local storage from all nodes in the cluster.
CMDB CI class models adds the classes and columns and the metadata associated with each class as related records in the following tables:

- CMDB Class Information [cmdb_class_info]: Class descriptions
- Identifier [cmdb_identifier]: Identification rules
- Identifier Entry [cmdb_identifier_entry]: Identification entries
- CMDB Metadata Hosting Rules [cmdb_metadata_hosting]: Dependent relationships

**View Nutanix Enterprise Cloud extension classes**

After installation, navigate to **Configuration** and then click **CI Class Manager**. When you click **Hierarchy** in CI Class Manager, the CI Classes list contains the added Nutanix classes. Select a class to see its corresponding class details, identification rules, identifier entries, and dependent relationships if applicable.

**Note:** Uninstalling the CMDB CI class models application might compromise the integrity of the CMDB and result in unexpected behavior.

**Classes**

The following classes are added:

<table>
<thead>
<tr>
<th>Class</th>
<th>Extends</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nutanix Cluster</td>
<td>Virtual Machine Object</td>
<td>Cluster comprising of the physical nodes running Nutanix software.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_cluster]</td>
<td>[cmdb_ci_vm_object]</td>
<td></td>
</tr>
<tr>
<td>Nutanix Controller VM</td>
<td>Application</td>
<td>Nutanix controller virtual machine that is present in each node and that provides the storage clustering and management capabilities.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_controller_vm]</td>
<td>[cmdb_ci_appl]</td>
<td></td>
</tr>
<tr>
<td>Nutanix Storage Container</td>
<td>Storage Volume</td>
<td>Subset of Nutanix storage pool used to apply policies such as reserved capacity, replication factor, and storage optimization options.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_storage_container]</td>
<td>[cmdb_ci_storage_volume]</td>
<td></td>
</tr>
<tr>
<td>Nutanix Storage Pool</td>
<td>Storage Pool</td>
<td>Grouping of physical disks within a Nutanix cluster which is typically used to create physical separation between virtual machines.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_storage_pool]</td>
<td>[cmdb_ci_storage_pool]</td>
<td></td>
</tr>
<tr>
<td>Nutanix Host</td>
<td>Virtualization Server</td>
<td>Physical host on which all the virtual machines run.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_host]</td>
<td>[cmdb_ci_virtualization_server]</td>
<td></td>
</tr>
<tr>
<td>Nutanix Virtual Machine Instance</td>
<td>Virtual Machine Instance</td>
<td>A virtual machine that runs on Nutanix infrastructure.</td>
</tr>
<tr>
<td>[cmdb_ci_nutanix_vm_instance]</td>
<td>[cmdb_ci_vm_instance]</td>
<td></td>
</tr>
</tbody>
</table>

**Nutanix Cluster**

The following columns are added in the Nutanix Cluster [cmdb_ci_nutanix_cluster] class.
<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Serial Numbers</td>
<td>Serial numbers of blocks that are connected to the cluster.</td>
</tr>
<tr>
<td>Cluster ID</td>
<td>UUID (Universal Unique Identifier) of the cluster.</td>
</tr>
<tr>
<td>External Subnet</td>
<td>Subnet of the external IP address of the cluster.</td>
</tr>
<tr>
<td>Full Version</td>
<td>Full version of the cluster.</td>
</tr>
<tr>
<td></td>
<td>For example: el7.3-release-euphrates-5.10.3.1-stable-655d4def34bf18785782f2adb8cdd5f8457d1fe3</td>
</tr>
<tr>
<td>Hypervisor Types</td>
<td>Types of hypervisors that are related to this cluster.</td>
</tr>
<tr>
<td>Internal Subnet</td>
<td>Subnet of internal IP addresses.</td>
</tr>
<tr>
<td>NCC Version</td>
<td>Nutanix cluster check version.</td>
</tr>
<tr>
<td>NTP Servers</td>
<td>NTP servers that are related to this cluster.</td>
</tr>
<tr>
<td>Number of Nodes</td>
<td>Number of nodes that are connected to the cluster.</td>
</tr>
<tr>
<td>Timezone</td>
<td>Timezone of the cluster.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the cluster.</td>
</tr>
<tr>
<td></td>
<td>For example: 5.10.3.1</td>
</tr>
</tbody>
</table>

**Nutanix Controller VM**

The following columns are added in the Nutanix Controller VM [cmdb_ci_nutanix_controller_vm] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hypervisor Type</td>
<td>Type of hypervisor.</td>
</tr>
<tr>
<td>Memory</td>
<td>Amount of memory (in MB) available to the virtual machine.</td>
</tr>
<tr>
<td>State</td>
<td>On/off state of power.</td>
</tr>
<tr>
<td>VM ID</td>
<td>UUID of the controller virtual machine.</td>
</tr>
<tr>
<td>Object ID</td>
<td>ID of the controller virtual machine.</td>
</tr>
</tbody>
</table>

**Nutanix Storage Container**

The following columns are added in the Nutanix Storage Container [cmdb_ci_nutanix_storage_container] class.

<table>
<thead>
<tr>
<th>Columns (added)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compression</td>
<td>Indicates whether compression is enabled.</td>
</tr>
<tr>
<td>Container ID</td>
<td>UUID of the container.</td>
</tr>
<tr>
<td>Columns (added)</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Deduplication</td>
<td>Indicates whether on disk deduplication is enabled, that is dedup compression applied to data on hard disks (HDD). Performance tier deduplication is a prerequisite for on disk deduplication.</td>
</tr>
<tr>
<td>Erasure Code</td>
<td>Indicates whether erasure coding is enabled.</td>
</tr>
<tr>
<td>Replication Factor</td>
<td>Number of maintained data copies. The replication factor is specified (2 or 3) when the container is created.</td>
</tr>
</tbody>
</table>

**Nutanix Storage Pool**

The Nutanix Storage Pool [cmdb_ci_nutanix_storage_pool] class has no added columns.

**Nutanix Host**

The Nutanix Host [cmdb_ci_nutanix_host] class has no added columns.

**Nutanix Virtual Machine Instance**

The Nutanix Virtual Machine Instance [cmdb_ci_nutanix_vm_instance] class has no added columns.

**Application services**

An application service is a set of interconnected applications and hosts which are configured to offer a service to the organization. Application services can be internal, like an organization email system or customer-facing, like an organization website.

ServiceNow applications refer to devices and applications that comprise an application service as configuration items (CIs). The various CIs and the relationships between them, that comprise an application service, are stored in the CMDB.

In the base system, you can manually create an application service and then populate it by adding CIs and their relationships from the CMDB. The system generates a map which shows the CIs and relationships in the application service. The system also tracks changes to application service and shows the history of those changes in the application service map.

All application services that you create manually or by using an API, or that are discovered by Service Mapping, are stored in the Application Service [cmdb_ci_service_discovered] table.

Activating Service Mapping or Event Management provides additional functionality for creating, updating, and using application services.

**Domain separation**

Domain separation, if deployed, impacts application services as follows:

- When creating an application service, the application service is assigned to the user's domain.
• When manually adding a CI to an application service, you can choose only CIs that belong to the service domain.
• When using the createOrUpdateService - POST REST API for creating or updating an application service, the process stops if one of the CIs referenced in the API belongs to a different domain than the application service itself.
• When converting business services into application services, the newly created application service belongs to the same domain as the original business service. The application service comprises only CIs belonging to the same domain as the application service itself.

**Application services APIs**

Application services provide several APIs that you can use to perform tasks such as creating an application service or adding a CI or a connection to an application service. See [Use application services APIs](#) for details about all application service APIs.

**Service Mapping**

If activated, Service Mapping discovers application services and automatically populates application services with discovered application and host CIs. If Service Mapping is activated, then an application service can comprise of manually added CIs and Service Mapping discovered CIs. Service Mapping creates and updates application services by communicating with individual CIs in the CMDB and identifying connections between the CIs. Service Mapping stores information about discovered CIs and relationships in the CMDB.

**Event Management**

Application services are associated with a criticality level which determines the prominence of an application service on the Event Management dashboard. You can also use a criticality value to define recovery strategies. For more information, see [Define criticality for application services](#).

**Manually create an application service**

Create an application service that does not contain any CIs.

Role required: app_service_admin

An application service is a set of interconnected applications and hosts which are configured to offer a service to the organization. Application services can be internal, like an organization email system or customer-facing, like an organization website. Use application services to organize, maintain, and monitor services in your organization.

You can specify an owner for the application service. The application service owner is a user who is familiar with the infrastructure and applications making up the service. This user is the application service SME who provides information necessary for a successful creation of an application service.

An application service has an entry point, which lets users access the application service. If you are at the planning stage and do not know what the entry points are for an application service, you can create the application service without entry points. Such application service is referred to as an empty application service, to which you can add entry points at any later time.

Service Mapping, if activated, can automatically discover and map application services as described in [Application service mapping](#). A discovered application service contains the CIs and the connections between them that Service Mapping discovered and mapped.
All application services, both manually created and discovered by Service Mapping, are stored in the Application Service [cmdb_ci_service_discovered] table.

You can also create an application service by using the createOrUpdateService - POST REST API.

1. Navigate to Configuration > Application Services > Application Services.
2. Click New.
3. Specify the basic application service attributes.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the application service name. This name must be unique. Use self-explanatory names such as mailing service or printing service.</td>
</tr>
<tr>
<td>Owner</td>
<td>Select an owner who is responsible for this application service in the organization.</td>
</tr>
</tbody>
</table>

4. Optional: Add entry points:
   a) In the Add Entry Point section, fill out the form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Type</td>
<td>Select the CI type (CI class) for the CI you are adding. Every CI belongs to a CI type which contains a set of attributes configured for this kind of CI, for example, cmdb_ci_appl for applications.</td>
</tr>
<tr>
<td>CI Name</td>
<td>Select the CI from the list of CIs of the selected CI type.</td>
</tr>
</tbody>
</table>

   The CI type list includes only allowed CI types. For example, you cannot add an application cluster.
   b) Click Add.
   c) To add additional entry points, click Add Entry Point and fill out the necessary details.

5. Click Save.
   This application service is added to the Application Service [cmdb_ci_service_discovered] table.

Manually add CIs to an application service

Convert a business service to an application service

Unify the way you manage services in your organization by converting manually created records in the Service [cmdb_ci_service] table into application services. Using application services lets you view maps and change history for services. If Event Management is deployed, you can monitor service performance and identify health issues for application services.

Role required: app_service_admin

During conversion:

- The service record is moved from the Service [cmdb_ci_service] table into the Application Service [cmdb_ci_service_discovered] table by changing the record class.
- The application service is set with all the original business service attributes such as name, owner, and operational status.
The system adds related items from the business service to the converted application service, up to the specified level.

All connections created between CIs in an application service are of the **Depends on::Used by** relationship type. You can modify this default relationship type by changing the value of the `sa.it_service.manual_ci_rel_type` property.

The system queries the CMDB for the latest CI changes.

Event Management, if activated, applies CI impact rules to CIs that are associated with alerts and that are part of the application service. Event Management deploys CI impact rules for alert monitoring.

A conversion might involve adding CIs of the following CI types, which cannot be added to an application service:

- `cmdb_ci_endpoint`
- `cmdb_ci_translation_rule`
- `cmdb_ci_config_file`
- `cmdb_ci_qualifier`
- `cmdb_ci_application_cluster`

If the original business service contains related items belonging to these CI types, then the system does not add such CIs or connections coming from them. If necessary, you can prevent CIs of other CI types from being added to application services by modifying the `sa.mapping.user.manual.citype.blacklist` property.

In environments with domain separation, only CIs belonging to the same domain as the application service are added to the application service. If there is a domain hierarchy, CIs must belong to the same child domain as the application service.

1. Navigate to **Configuration > Business Services**.
2. Select the business service that you want to convert to an application service.
3. Click **Convert to Application Service**.
4. In the Converting to Application Service dialog box, select a number from the **Up to** list, as the number of levels of related CIs to include in the conversion.
   - The maximal number of levels is eight.
5. Click **OK**.

The system adds the CIs from the business service to the converted application service.

**Manually update an application service with changes from the CMDB**

Ensure that an application service is up-to-date and reflects all the latest changes to its configuration items (CIs). Regularly update application services to reflect any changes to CIs and their relationships in the CMDB.

Role required: app_service_admin

An example of a change is deleting CIs from the CMDB or connecting two CIs one of which is part of an application service. In the first case, your application service may show a CI that no longer exists. In the second case, on the contrary, the application service omits a CI.

There is no mechanism or an API that automatically updates application services that were created manually. Also, you may need to manually update application services discovered by Service Mapping, if they contain manually added CIs. You can only update application services which contain manually created entry points and which are not discovered by Service Mapping.

An update might involve adding CIs of the following CI types, which cannot be added to an application service:

- `cmdb_ci_endpoint`
ServiceNow    DocVersion    Now Platform capabilities

- cmdb_ci_translation_rule
- cmdb_ci_config_file
- cmdb_ci_qualifier
- cmdb_ci_application_cluster

If necessary, you can prevent CIs of other CI types from being added to application services by modifying the sa.mapping.user.manual.citype.blacklist property.

All connections created between CIs in an application service are of the **Depends on::Used** by relationship type. You can modify this default relationship type by changing the value of the sa.it_service.manual_ci_rel_type property.

Also, the system can connect a CI from the application service only to actual CIs that exist in the CMDB, not a visualization of other items on the map like clusters or boundaries.

In environments with domain separation, only CIs belonging to the same domain as the application service are added into the application service. If there is a domain hierarchy, CIs must belong to the same child domain.

You can also update application services by using APIs.

1. Navigate to **Configuration > Application Services > Application Services**.
2. Alternatively, if Service Mapping is deployed, navigate to **Service Mapping > Services > Application Services**.
3. Select the application service that you want to update.
4. Click **Update with changes from CMDB** under Related Links.
5. Select a number in the **Up to** list to limit the number of levels of related items to be updated.
   
   If the specified number is higher than the number of levels of related items that already exist in the application service, then the system adds the missing CIs and their connections.

   **Warning:** Specifying a lower number than the number of levels that already exist in the application service, does not result in the removal of CIs from the application service.

6. Click **OK**.

   - The system updates the application service with the changes from the CMDB and shows them on the map.
   - After the update process is complete, the application service form opens.

**Manually add CIs to an application service**

Add configuration items (CIs) to manually created application services or to services discovered by Service Mapping.

- Verify that the CI type for the CI that you are planning to add, exists. If necessary, create the CI type as described in Create CI types for Service Mapping and Discovery.
- Add CIs to the CMDB for the device or application that you want to add, if necessary. See Populate the CMDB for more information.

Role required: app_service_admin or sm_admin

You can populate an application service that was created manually, by manually adding the CIs comprising it. Adding a CI to an application service requires creating a relationship between the new CI and a CI in the application service.

Information about the CI in application service, to which you are connecting a new CI, is updated in the CMDB. This information includes the type of the relationship between the CIs. If other application services
use the same applicative flow, the CMDB recognizes it and adds the CI you added manually to these application services by analogy. For example, you manually added an IBM WebSphere Message Broker to an IBM WebSphere HTTP Listener in the Bank Customer Portal service. The system also adds this IBM WebSphere Message Broker to the same HTTP Listener in the Bank Internal Portal, because it uses this HTTP Listener. The same logic applies when you remove a CI you added manually: The system removes it from all application services where you either manually added it or the system added it by analogy.

All connections created between CIs in an application service are of the Depends on::Used by relationship type. You can modify this default relationship type by changing the value of the sa.it_service.manual_ci_rel_type property.

You can manually connect a CI only to actual CIs existing in the CMDB, not to a visualization of other items on the map such as clusters or boundaries. Also, it is prohibited to add CIs of these CI types to an application service:

- cmdb_ci_endpoint
- cmdb_ci_translation_rule
- cmdb_ci_config_file
- cmdb_ci_qualifier
- cmdb_ci_application_cluster

If necessary, you can prevent CIs of other CI types from being added to application services by modifying the sa.mapping.user.manual.citype.blacklist property.

In environments with domain separation, only CIs belonging to the same domain as the application service are added to the application service. If there is a domain hierarchy, CIs must belong to the same child domain as the application service.

If working with an application service discovered by Service Mapping, manually add a CI:

- To indicate that an application service contains a device or application, which Service Mapping cannot discover. For example, add an A/C unit to the Production Floor service.
- To add a temporary placeholder for a CI, which Service Mapping did not discover. In this case you are planning to perform necessary troubleshooting to ensure that Service Mapping discovers this CI in the future. For example, add an IBM WebSphere Message Broker to the Bank Customer Portal service.
- To create an application service that combines entry points and CIs automatically discovered by Service Mapping with entry points and CIs from the CMDB. After you manually add an entry point, you can update the application service with CIs from the CMDB based on the relationships defined there.

For additional information related to Service Mapping, see Pattern customization and Enable traffic-based discovery for CI types or specific CIs.

1. Navigate to Configuration > Application Services > Application Services.
2. Alternatively, if Service Mapping is deployed, navigate to Service Mapping > Services > Application Services.
3. Open the relevant application service map:
   a) Click View map next to the relevant application service.
   b) If needed, click Edit to ensure that the map is in Edit mode.

   If Service Mapping is deployed, then in Edit mode, the Discovery Messages section appears below the map.

4. To connect a CI to another CI on the map, right-click the CI to which you want to connect the new CI, and then select Add a CI.
5. In the Add A CI dialog box, specify the CI to add:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Type</td>
<td>Select the CI type (CI class) for the CI you are adding. Every CI belongs to a CI type which contains a set of attributes configured for this kind of CI, for example, <code>cmdb_ci_appl</code> for applications.</td>
</tr>
<tr>
<td>CI Name</td>
<td>Select the CI from the list of CIs of the selected CI type.</td>
</tr>
</tbody>
</table>

The CI type list includes only allowed CI types. For example, you cannot add an application cluster.

6. Click **Submit**.

The manually added CI appears on the map.

**Note:** When you manually add a CI, which is an application, as a child to a service that already includes its parent application CI, the newly added child application CI is hidden inside the inclusion. Click the plus (+) symbol next to the parent application CI to see the child application CI.

7. Optional: (If Service Mapping is activated) To add a discoverable outgoing connection for the manually added CI:
   a) Right-click the manually added CI.
   b) Select **Manually add a connection**.
   **Note:** If you do not see the **Manually add a connection** option in the right-click menu, check that you are logged in with the user that belongs to the same domain as the application service.
   c) Configure attributes for the entry point as described in **Entry points attributes**.
   d) Click **Submit**.

Discovery and Service Mapping attempt to discover this CI. If successful, the CI appears on the map. Otherwise, a warning icon appears.
8. Optional: (If Service Mapping is activated) If you want Service Mapping to automatically discover a CI, which you previously added manually:
   a) Customize the relevant pattern or fine-tune traffic-based discovery to enable Service Mapping to discover the CI.
   b) Navigate to the relevant application service map.
   c) Click **Run discovery**.
   d) After the discovery process finishes, verify that Service Mapping discovered the CI by checking the connector leading to the CI. If Service Mapping discovered the CI, then two connectors, a manual and automatically discovered, appear for the CI.
   
   ![Image of a service map with connectors]

   e) Right-click the CI you added manually.
      In the example, it is IBM WebSphere Message Broker.
   
   f) Select **Remove manually added CI**.
      The map shows the CI with only one connector leading to it. If this CI had any manually added connections, they are removed together with the manually added CI.
**Link application services**

You can manually add to one application service a reference to another application service. Ensure that you know the name of the application service that you want to add a reference to.

Role required: app_service_admin or sm_admin

An application service can be part of another application service, in which case you can link one to the other. To link, edit an application service, and add a reference to another application service as an outgoing connection of the relevant CI inside the other application service.

When you link an application service to another application service, the information about the CI, to which you linked the service, is updated in the CMDB. The CMDB recognizes other application services that use the same applicative flow, and adds the application service you linked to these application services by analogy. The same logic applies when you remove a linked application service: The system removes it from all application services where you either manually linked this service or the system linked this service by analogy.

When using Service Mapping, you may want to link application services to create:

- A link between two discovered services.
- A placeholder for a map branch that Service Mapping failed to discover. If you modify or add a pattern that can discover the configuration item (CI) serving as an entry point for the linked application service, Service Mapping can discover this linked service.
- An indication that an application service contains a branch, which Service Mapping cannot discover.
You can link application services to one another to create dependencies for impact monitoring in Event Management.

1. Navigate to Configuration > Application Services > Application Services.
2. Alternatively, if Service Mapping is deployed, navigate to Service Mapping > Services > Application Services.
3. Click View map next to the application service which you want to link to another application service.
4. Right-click the CI to which you want to link an application service as a reference.
5. Select Add A CI.
6. In the Add a CI dialog box, select the application service you want to add as a reference:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Type</td>
<td>Select Application service from the list.</td>
</tr>
<tr>
<td>CI Name</td>
<td>Select the name of the application service that you want to link as a reference.</td>
</tr>
</tbody>
</table>

7. Click Submit.
   The icon for the linked service appears on the map.

Navigate to the linked application service, and double-click its icon on the map. The map window shows the linked application service.

Service maps contain no indication of transferred services being linked to their original services. You may need to know if a service is a part of another, larger service when dealing with changes or incidents. Use the updateset to add the ability to view the list of all application services that contain a certain service as a link, as described in KB0748865:Viewing list of application services that contain a certain service as a link.

**Group application services**

Organize application services by groups to perform actions simultaneously on multiple services, and to control user access to services. You can use Event Management to track service health by service groups.

Role required: sm_admin or app_service_admin

Typically, enterprises have hundreds of services which makes it impractical to manage them individually. Service groups can make service lists much shorter and easier to manage, especially in large organizations or service providers.

How you group application services depends on the user and on service provisioning policies in your enterprise. The relation between application services in groups is purely logical and the same application service can belong to multiple groups. For example, the Mobile service can be part of the following service groups: sales, Beijing, and telephony.
Example of an application service belonging to different groups

You can embed a service group within another service group to create a hierarchy of service groups. If users have access to a parent service group, they automatically have access to all its child groups. By default, all new services are assigned to the All service group that lets all users view and manage application services. When you assign a role to a service group, the users with this role can access application services in this service group and in the All service group. To enable users with this role to access other services, assign this role to the respective service group. Do not assign user roles directly to the All service group.

If Service Mapping is activated, service groups can contain a mixture of manually created application services and application services discovered by Service Mapping.

You can use Now Platform Notifications to alert users if the service group severity changes to critical. The overall severity of the group is determined by the highest alert severity within the group.

1. Navigate to Configuration > Application Services > Service Groups. Or, if Service Mapping is activated, navigate to Service Mapping > Services > Service Groups.
2. Click New.
3. Enter the name of the new application service group in the Name field.
4. To embed this group in another group, enter the name of the other group in the Parent Group field.
5. Right-click the form header and click Save.
6. Add an application service to the newly created service group.
   a) In the Service Group Members section, click **New**.
   b) In the **Name** field, enter the name of the application service. If you are using Event Management, you can also enter an alert group name.
   c) Click **Submit**.

7. Alternatively, add an application service to a group from the application service form.
   a) Navigate to **Configuration > Application Services > Application Services**.
   b) Select the application service you want to add to a service group.
   c) In the **Service Group Members** section, double-click **Insert a new row**.
   d) Enter the name of the service group to which you want to add the selected application service.
   e) Click the **OK** icon (✔).
   f) Click **Update**.

Control user access to application services

Assign user roles to service groups to grant users access to application services in your organization. Your organization may restrict access to some services for security or secrecy reasons.

Make sure that you have performed the user provisioning tasks for the users you want to grant access:

1. Add users to user groups.
2. Create new roles.
3. Assign roles to users or user groups.

Also, make sure that you have created service groups as described in **Group application services**.

Role required: app_service_admin or sm_admin

In the base system, the following roles provide access to application services:

**app_service_admin**

Creates and modifies application services, creates service groups, views, and edits application service maps.

**app_service_user**

Views application service maps. The itil role that serves as the basic helpdesk technician role contains the app_service_user role.

Service Mapping provides these preconfigured roles:

**sm_admin**

Sets up the Service Mapping application. Maps, fixes, and maintains application services. Also performs advanced configuration and customization of the product. Assign this role to application administrators.

**sm_user**
Views maps for operational application services to plan change or migration, as well as analyze the continuity and availability of services. Assign this role to application users.

**sm_app_owner**

Provides information necessary for successful mapping of an application service. Once a service is mapped, this user reviews the results and either approves it or suggests changes. Assign the sm_app_owner role to users who own application services and are familiar with the infrastructure and applications that make up the services.

Event Management provides these preconfigured roles:

**evt_mgmt_admin**

Has read and write access to all Event Management features to configure Event Management.

**evt_mgmt_operator**

In addition to the evt_mgmt_user permissions, can also activate operations on alerts such as acknowledge, close, open incident, and run remediations.

**evt_mgmt_user**

Has read access to all Event Management features. Has write access to alerts to manage the alert life. Has the itil role to be able to manage incidents that are created from alerts.

**evt_mgmt_integration**

Has create access to the Event [em_event] and Registered Nodes [em_registered_nodes] tables to integrate with external event sources.

Typically, enterprises have hundreds of services which makes it impractical to manage them individually. Service groups can make service lists much shorter and easier to manage, especially in large organizations or service providers. In a hierarchy of service groups, access to a parent service group automatically grants access to all the child service groups.

Users inherit permissions from roles that are assigned to them. You can assign some roles directly to service groups to allow all users with this role to access all application services belonging to this group. However, most enterprises choose to organize their roles as a hierarchy. It helps to manage roles across multiple ServiceNow applications. For example, the Service Mapping administrator [sm_admin] can be part of a broader administrator role like administrator [admin]. You can add users to user groups and then assign roles to the user groups to give permissions of this role simultaneously to all the group users.
Assigning a role to an application service group

By default, all new services are assigned to the All service group that lets all users view and manage application services. When you assign a role to a service group, the users with this role can access application services in this service group and in the All service group. To enable users with this role to access other services, assign this role to the respective service group. Do not assign user roles directly to the All service group.

**Note:** Some references in the user interface to business services are actually references to application services.

1. Navigate to either of the following:
   - Configuration > Application Services > Service Group Responsibilities.
   - If Service Mapping is activated: Service Mapping > Services > Service Group Responsibilities.
   - If Event Management is activated: Event Management > Services > Service Group Responsibilities.

2. Click **New** and fill out the Business Service Group Responsibilities form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Service Group</td>
<td>Service group to which you want to assign a role.</td>
</tr>
<tr>
<td>Role</td>
<td>Role you want to assign to the selected service group. For example, financial_services_admin.</td>
</tr>
</tbody>
</table>
3. Click **Submit**.

To manage access to services that contain sensitive financial information in your organization:

1. Organize the services into the Financial Services group.
2. Create a new user role, financial services administrator \( \text{[financial\_services\_admin]} \) role, that contains the \( \text{[app\_service\_admin]} \) role.
3. Assign the Financial Services administrator role to the Financial Services group.

As a result, only users with the Financial Services administrator role can access application services belonging to the Financial Services group.

**View an application service map in base system**

An application service map provides a visualization of data for the CIs comprising an application service, and the relationships and connections between these CIs.

Role required: \( \text{app\_service\_user} \) to view the map in View mode, and \( \text{app\_service\_admin} \) to modify services in Edit mode.

When you create an application service, the system generates an associated application service map. The system then updates the map to reflect any changes to the application service. This map consists of icons representing CIs and arrows that represent the connections between them.

If Service Mapping is deployed, see Application service maps and View CI connection attributes in an application service map for more details.

To open an application service map, navigate to Configuration > Application Services > Application Services and then click the View map link. You can then perform any of the following operations.

- Click on the windows bar to navigate to a different application service.
- Use the navigation tools to increase or decrease the view of the map and to move the map on the page. You can also click anywhere on the map area and drag a segment of the map into the visible area.
• View changes: You can view changes and change records associated with the application service as a whole or with any of its CIs, within a time range. For more information, see View the change history of application services.

Records under the Change tab underneath the map, which are associated with a selected CI or connection, are highlighted. If you select a change record under the Change tab, then the associated CI icon appears yellow on the map.

• View attributes: When you select a device, application, or connector on the map, it appears in blue and its attributes appear in the Properties pane on the right of the map. When nothing is selected on the map, the details of the application service itself appear on the Properties pane.

• Open the CI's form for further details by clicking Detailed Properties at the bottom of the Properties pane.

• Click Edit or View to switch the map mode. Edit mode lets you add or remove CIs from the map.

• Click for Additional actions:

  • Set Group CIs on map: Simplify maps by grouping 10 or more CIs belonging to the same type and hosted on servers sharing prefix and domain name.
  
  • Set Spanning tree view: Simplify the map by organizing CIs into a tree structure and hiding some connection lines. This option is especially useful for very large maps.
  
  • Map Indicators: Show additional information for a CI or for the application service itself by displaying related records such as alerts, outages, incidents, and problems. For each indicator that is enabled, the corresponding indicator icon appears next to CIs with associated records, and the corresponding tab appears underneath the map. If a record is associated with the application service itself, the indicator appears next to the application service name.

  For information about managing map indicators, see Create or modify map indicators. For more general information, see Event Management Map Indicators (Video).

• Export to PDF: Export the map to a .PDF file which you can then share as needed. After the PDF file is ready, click to download the PDF file to your local drive.
• View the details of a connection.

By default, connection lines for the same CI on an application service map, are merged. This merge reduces clutter on the map and helps to make the map more readable. For a merged connection line, you can view details for all the underlying connection lines.

• To view the source and target CIs of a connection, right-click a connection line.

If spanning tree view is enabled:
  1. Click the CI whose connections you want to view to show all the concealed connections for the CI.
  2. Right-click one of the connection lines.

• To view properties of a connection, click a connection line. For manually added connections, Endpoint Type is Manual Endpoint.

• To view properties of a connection within a merged connection:
  1. Right-click the merged connection line.
  2. Select one of the connections.
3. Select Select edge.

You can change the details that appear in the Properties pane by updating the form view 'Form view and section', as described in Configuring the form layout.

**View CI attributes in an application service map**

An application service map displays attributes for each configuration item (CI) that is part of the application service, as well as for the application service itself. The attributes come from the CMDB.

Role required: sm_admin or sm_user

You can view the following information for each CI:

**Name label**

The CI name. This attribute is either preconfigured on the CI or configured during CI installation.

**Basic attributes**

A summary of the most important CI attributes.

**Detailed attributes**

A complete list of all attributes collected for the CI.

Each CI type (CI class) has different attributes. For example, the Linux Server type has different attributes than the SQL Instance type.

If Service Mapping is deployed, the way CIs appear on the map depends on the view you select for the map. Attributes available for viewing also depend on the Service Mapping setup. For more information see description of components installed with Service Mapping.

The following user interface screens refer to application services as business services: Business Service Group Responsibilities, Approve, Service Mapping Properties, and Service Map Planner.

1. Navigate to Configuration > Application Services > Application Services.
2. Alternatively, if Service Mapping is deployed, navigate to Service Mapping > Services > Application Services.
3. Click View Map next to the relevant application service.
4. To see the full name of a CI whose name has been shortened on the map, point to the CI. A tooltip displays the full CI name.
5. Click a CI to see its details in the **Properties** pane. The attributes of applications and the servers that host them appear separately.

![Diagram of CI properties view](image)

6. To view more detailed attributes for the CI, click **Detailed properties** at the bottom of the Properties pane.

7. Optional: (If Service Mapping or Discovery are enabled, and if tracking changes to configuration files is enabled for a CI) To view configuration files associated with a CI:
   - Review the list of files under **Tracked Files** in the **Properties** pane. Click the file name to open the actual file.
   - Click the **Affected CIs** tab and view the list of configuration files. Click the file name to open the actual file.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
View the change history of application services

You can view changes made to an application service as a whole and to the individual configuration items (CIs) comprising the service. Change history is useful for maintenance, planning, or troubleshooting procedures.

Role required: admin, sm_admin, sm_user, app_service_admin, or app_service_user

Details about changes to an application service and to its CIs is stored in the CMDB. Typically, these changes reflect adding or removing CIs from an application service, upgrading or updating CIs, or modifying CI configuration files. The system gathers this data by querying CMDB tables and then creating the change history view. In deployments where Service Mapping is activated, the type of change information Service Mapping queries depends on discovery patterns that Service Mapping uses to discover CIs.

Changes to configuration files are associated with CIs to which these files belong. Maps show configuration file changes as changes to related CIs.

While you can see change records for a specific CI in the context of application services, you can also see detailed history of a specific CI separate from its application service as described in History Timeline.

If the is configured to validate changes, all changes are evaluated and rendered as valid or not. If a change is valid, its change record on the application service map is marked as approved. For more information about configuring the platform for change validation, see Managing proposed changes.

Changes to the application service appear on the history timeline.

The type of change mark depends on the nature of changes that it represents:

Light gray balloon

Unapproved change that does not influence the application service behavior. For example, a change in a network path or adding a node to a cluster.

Dark gray balloon

Unapproved change that changes the application service behavior.

Green balloon

An approved change in deployments where the is configured to validate changes.
Double balloon

Multiple separate changes that happened a short time from each other.

You can mark times on the history scale by creating baselines to quickly return to the marked view.

The following user interface screens refer to application services as business services: Business Service Group Responsibilities, Approve, Service Mapping Properties, and Service Map Planner.

1. Navigate to Configuration > Application Services > Application Services.
2. Alternatively, if Service Mapping is deployed, navigate to Service Mapping > Services > Application Services.
3. Click View map for the application service for which you want to see change history.

Actions or map elements which are relevant only for application services discovered by Service Mapping, do not appear on maps for manually created application services.

The Changes tab at the bottom of the page shows all change records created for this application service.

4. On the history timeline, set the time range of changes that you want to view.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>To set the time range of the history timeline</td>
<td>Click the hour, day, week, or month icons.</td>
</tr>
<tr>
<td>To increase or decrease the time range</td>
<td>Click the zoom in and zoom out icons.</td>
</tr>
<tr>
<td>Option</td>
<td>Action</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>To change the upper limit on your history range</td>
<td>Click the history scale.</td>
</tr>
</tbody>
</table>

The time that serves as the upper limit appears above the history timeline.

**Note:**
You cannot set the lower limit on your history range to a time before this application service was created. This time is marked with the **IT Service Created** event on the history timeline.

The map shows the history view of the application service for the time you selected.

**Note:** The **Change** tab shows all change records, even the ones which are filtered out of the history view.
5. To mark a time on the time scale, set a baseline:
   a) Click the **Compare** icon.
   b) Navigate to the time you want to mark as a baseline on the history scale.
   c) Click **Set baseline**.
   d) Enter the name of the baseline and click **OK**.
      The new baseline appears as a button above the history scale and as a blue flag on the history scale.
6. **View the change history:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To see the CI responsible for a change record</strong></td>
<td>Select a change record on the <strong>Changes</strong> tab. &lt;br&gt;The related CI is marked yellow in the map.</td>
</tr>
</tbody>
</table>

---

![Change History](image-url)
<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>To see only change records related to a CI</td>
<td>Select the required CI or the connection on the map. The Changes tab displays only change records related to the selected CI or connection.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
</table>
| To see the configuration file at the selected moment in the past | a. Set the time on the history scale.  
b. In the Properties pane, scroll to Tracked Configuration Files, and click the file name. The new tab opens displaying the content of the tracked configuration file at the selected time. |
7. To exit the history view and see the current status of the application service, click the current icon.

Compare two versions of an application service

You can see a summary of application service changes at a glance by comparing two versions of an application service. This feature is useful for checking the application service status before and after a certain change or problem.

Role required: admin, app_service_admin, app_service_user, sm_admin, or sm_user

Specify two points in time for which to compare the two versions of an application service. You can use the change indicators on the timeline to specify one point in time that is before and another that is after a change for which to see the details. For example, if you know that the application service started to fail at a certain time, you can compare two versions of the application service, one before and one after the problem started. This comparison lets you see the summary of changes that possibly led to the problems.

Service Mapping, if deployed, tracks and shows all changes to a CI including configuration files associated with a CI. When you compare two versions of an application service, you can see changes made to configuration files as changes to CIs. You can also compare two versions of a configuration file to see the actual changes in the files, during the time range specified for the comparison.

The following user interface screens refer to application services as business services: Business Service Group Responsibilities, Approve, Service Mapping Properties, and Service Map Planner.

1. Navigate to Configuration > Application Services > Application Services.
2. Alternatively, if Service Mapping is deployed, navigate to Service Mapping > Services > Application Services.
3. Click View Map next to an application service.
4. On the history timeline, set the time range of changes that you want to view.

Option | Action
--- | ---
To see network at the selected moment in the past | a. Set the time on the history scale.
b. Right-click the connection and select Show network path.
The new tab opens displaying the network or storage path map for the time you selected.

Note: You cannot view the network path for connections marked as boundaries to this application service.
<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>To increase or decrease the time range</td>
<td>Click the zoom in and zoom out icons.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Zoom Icons" /></td>
</tr>
<tr>
<td>To change the upper limit on your history range</td>
<td>Click the history scale.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="History Scale" /></td>
</tr>
</tbody>
</table>

The time that serves as the upper limit appears above the history timeline.

**Note:**
You cannot set the lower limit on your history range to a time before this application service was created. This time is marked with the **IT Service Created** event on the history timeline.

The map shows the history view of the application service for the time you selected.

**Note:** The **Change** tab shows all change records, even the ones which are filtered out of the history view.

5. Click the **Compare** icon.
6. Set **Compare point 1** and **Compare point 2** as the two points in time for the comparison.
   You can drag the pointers on the history scale to set corresponding time points.

   ![Comparison Interface](image)

   If the history scale does not include the time set for comparison, then its corresponding pointer appears next to the compare point in yellow:

   ![Comparison Interface](image)

   **Note:** If there are no changes to the service during the time interval specified by **Compare point 1** and **Compare point 2**, then no change details are displayed.

7. Click **Compare**.
   The comparison view opens in a separate tab.
8. Select a marked CI to see the relevant change record on the Changes tab.
9. Optional: If Service Mapping is deployed, you can compare two versions of a configuration file that appears on the map as Updated:
   a) Select the CI that is associated with the updated configuration file.
   b) In the Properties pane, click the link to the updated file.

   ![Image showing Service Mapping and Tracked Configuration Files]

   The **Tracked Configuration Files Version Compare** tab opens showing two versions of the configuration file side by side.

   c) Review actual changes.
      
      Highlight colors indicate the type of change:
      
      - Purple — Updated line
      - Pink — New line
      - Gray — Deleted line

   d) Navigate between the changes using the arrows in the upper right corner.

   e) Close the **Tracked Configuration Files Version Compare** tab when finished.
10. Close the comparison view when finished.

**Use application services APIs**

Application services provide APIs that let you perform operations such as creating and updating an application service, populating it with CIs from the CMDB, and retrieving details from an existing application service.

Role required: app_service_admin

An application service is a set of interconnected applications and hosts which are configured to offer a service to the organization. Application services can be internal, like an organization email system or customer-facing, like an organization website.

**Create an application service**

Using the `createOrUpdateService` - POST REST API to create an application services suits your organization if the ServiceNow CMDB already contains the CIs making up the service. Typically, it is the case when you have manually added CIs directly into the CMDB, or used the Discovery application to discover CIs and store information about them in the CMDB. You can also use this API to create application services containing CIs discovered using non-ServiceNow applications.

By default, when an application service is created, all CI connections are of the **Depends on:**-**Used by** relationship type. You can modify this default type by changing the value of the `sa.it_service.manual_ci_rel_type` property.

Before creating an application service, ensure that:

- The CMDB contains all the CIs comprising the application service.
- You have the `sys_id` of each CI comprised in the application service you want to create.
- You understand the hierarchy that the CIs form.

The Application Service `[cmdrb_ci_service_discovered]` table contains all application services including services you create using APIs.

You can also manually create application services using the user interface as described in Manually create an application service.

**Retrieve content from an application service**

Use the `getContent` - GET REST API to retrieve a list of CIs and the relationships between them, for an application service that was created manually.

**Additional APIs**

The following JavaScript APIs are also available:

- `addCI()`: Add a CI to a manually created an application service.
  
  For restrictions on the CIs being added and other details about adding CIs to application services, see Manually add CIs to an application service.
- `addManualConnection()`: Add a manually created connection to an application service.
- `migrateManualToApplicationService()`: Convert a manual service to an application service.
- `populateApplicationService()`: Populate an application service with CIs and relationships from the designated entry point.
• `removeCI()`: Remove a manually created CI from an application service.
• `removeManualConnection()`: Remove a manually created connection and the connected CI from an application service.

**Components installed with application services**

Several types of components are installed with activation of the Application Service [com.snc.cmdb.it_service] plugin, including tables, user roles, and scheduled jobs.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>[app_service_user]</code></td>
<td>Provides read-only access to application services, and ability to call any GET APIs (GetContent).</td>
<td>• None</td>
</tr>
<tr>
<td><code>[app_service_admin]</code></td>
<td>Provides access to all basic functionality related to application services. This basic functionality includes creating services, and adding and removing CIs from services.</td>
<td>• itil</td>
</tr>
</tbody>
</table>

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BaseLines [sa_baselines]</td>
<td>Storing points in the time defined as baselines for application services.</td>
</tr>
<tr>
<td>Business Service User preferences [sa_business_service_user_prefs]</td>
<td>User preferences associated with a specific application service.</td>
</tr>
<tr>
<td>Menu Action [sa_context_menu]</td>
<td>Data on configurable menu options for CIs in the application service map.</td>
</tr>
<tr>
<td>Hash [sa_hash]</td>
<td>Internal table which contains counters and hashes on various types of updates related to application services.</td>
</tr>
<tr>
<td>Entry Point [sa_m2m_service_entry_point]</td>
<td>Maps entry points to application services.</td>
</tr>
<tr>
<td>Discovered Service Notification [sa_notification]</td>
<td>Internal table which contains data on notifications between different parts of the software. Mostly used after activating Service Mapping.</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Group Members</td>
<td>Maps service groups to application service members.</td>
</tr>
<tr>
<td>[sa_service_group_member]</td>
<td></td>
</tr>
<tr>
<td>Business Service Group Responsibilities</td>
<td>Data on users having access to application service groups.</td>
</tr>
<tr>
<td>[sa_service_group_responsibilities]</td>
<td></td>
</tr>
<tr>
<td>Checkpoint Attribute Description</td>
<td>Links between history timeline changes and service model internal entities (checkpoints). Used in lists of history of changes in application service maps.</td>
</tr>
<tr>
<td>[checkpoint_attribute_description]</td>
<td></td>
</tr>
<tr>
<td>Application Services</td>
<td>Services that can be monitored by the system, which in the base system, includes only application services. If Service Mapping is activated, there can also be records for technical services. If Event Management is activated, there can be records for alert groups.</td>
</tr>
<tr>
<td>[cmdb_ci_service_auto]</td>
<td></td>
</tr>
<tr>
<td>Mapped Application Service</td>
<td>Application service CIs. For each application service, there is a container CI record that models the application service.</td>
</tr>
<tr>
<td>[cmdb_ci_service_discovered]</td>
<td></td>
</tr>
</tbody>
</table>

### Properties installed

To access application services properties, navigate to **Configuration > Application Services > Properties**. The role required for modifying property values, is **app_service_admin**.

If Service Mapping is deployed, see **Properties installed with Service Mapping** for additional application service properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
</table>
| The sys_id of the default relation type to be added between source and target when adding CI manually to application service | • **Type**: string  
  • **Default value**: 5599a965c0a8010e00da3b58b113d70e (Depends on::Used by)  
  • **Learn more**: Manually add CIs to an application service |
| sa.it_service.manual_ci_rel_type                                         |                                                                      |
| Coefficient of aggregation interval. 0 value means no aggregation is performed on history timeline. The purpose of this property is to decrease number of changes in history timeline by increasing the interval allowed between changes | • **Type**: integer  
  • **Default value**: 1 |
<p>| sa.history.aggr_interval_coef                                           |                                                                      |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
</table>
| A list of comma delimited CI types that are excluded when using the 'Convert to Application Service' and 'Populating Application Service from CIs in the CMDB' operations. Example: cmdb_ci_service,cmdb_ci_endpoint,cmdb_ci_hardware | This exclusion list applies when:  
• Manually adding CIs to an application service  
• Converting a business service to an application service  
• Creating or updating an application service using APIs  
• Manually updating an application service with changes from the CMDB  
• **Type**: string  
• **Default value**: None |
| sa.mapping.user.manual.citype.blacklist                                  |       |
| Sync Service Mapping operations with Service Modeling                  |       |
| sa.service_modeling.use                                                  |   **Type**: true|false  
• **Default value**: true |
| Enable limitation of application service maps drawing by number of nodes and edges. sa.map.LIMIT_MAX_GRAPH_SIZE | Limit the number of nodes and edges on application service maps.  
• **Type**: true|false  
• **Default value**: true  
Setting this property to false may reduce performance in maps of large services. |
| Maximal number of displayable nodes on application service map. Maps with larger values will not be displayed. sa.map.MAX_NODES_FOR_LAYOUT | The max number of nodes displayed on an application service map. If the number of nodes exceeds the specified number, the map does not appear and an error message appears.  
• **Type**: integer  
• **Default value**: 5000 |
| Global flag to allow or disable spanning tree view for maps. true (default) - allows but not forces spanning tree view on maps. sa.map.ALLOW_SPANNING_TREE_VIEW | Enable spanning tree view for application service maps.  
• **Type**: true|false  
• **Default value**: true |
| Maximal number of displayable edges on application service map before spanning tree view applied. sa.map.MAX_EDGES_FOR_FULL_LAYOUT | The max number of edges displayed on an application service map, before applying spanning tree view.  
• **Type**: integer  
• **Default value**: 1000 |
<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximal number of displayable edges on application service map. Maps with larger values will not be displayed.</td>
<td>Max number of edges displayed on an application service map. If the number of edges exceeds the specified number, the map does not appear and an error message appears.</td>
</tr>
<tr>
<td>sa.map.MAX_EDGES_FOR_LAYOUT</td>
<td>• Type: integer • Default value: 100000</td>
</tr>
<tr>
<td></td>
<td>Increasing the default value may reduce performance in maps for large services.</td>
</tr>
<tr>
<td>Maximal degree of node on application service map for large map mode.</td>
<td>• Type: integer • Default value: 100</td>
</tr>
<tr>
<td>sa.map.LIMIT_GRAPH_DEGREE</td>
<td>Increasing the default value may reduce performance in maps for large services.</td>
</tr>
<tr>
<td>Limit of amount of services that displayed on Services Tree on maps.</td>
<td>• Type: integer • Default value: 7000</td>
</tr>
<tr>
<td>sa.service_tree.MAX_ITEMS_TO_DISPLAY</td>
<td></td>
</tr>
<tr>
<td>Maximal amount of connection properties to be shown at once when connection line selected on service map. If selected line contains more connections than defined here, then properties panel will have notification about cut-off connections.</td>
<td>• Type: integer • Default value: 50</td>
</tr>
<tr>
<td>sa.map.max_connections_in_properties_panel</td>
<td></td>
</tr>
<tr>
<td>Enable grouping of CIs on map.</td>
<td>• Type: true</td>
</tr>
<tr>
<td>sa.map.enable_auto_grouping</td>
<td></td>
</tr>
<tr>
<td>Minimal number of CIs on a map to apply CI grouping. Relevant only if CI grouping is enabled on the map. The following CIs are not counted: discovered clusters, internal CIs inside inclusion boxes, entry points, error nodes, host CIs or CIs that are not hosted on other CIs.</td>
<td>• Type: integer • Default value: 10</td>
</tr>
<tr>
<td>sa.map.min_nodes_for_auto_grouping</td>
<td></td>
</tr>
<tr>
<td>Render full labels on CIs on map. Applicable to all CI labels (CI name, host name, cluster label, etc.) Enabling this will disable labels truncation, and labels will most probably overlap with other map elements. Not applicable to network/storage path maps.</td>
<td>The default value of disabled, means none.</td>
</tr>
<tr>
<td>sncCommonMap.RENDER_FULL_LABELS</td>
<td>• Type: choice list • Default value: Disabled • Other possible values: • Exported PDF only: pdf • Map and PDF views: all</td>
</tr>
<tr>
<td>Property</td>
<td>Usage</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Maximal width of CI node labels in pixels. Relevant for any kind of labels (CI name, host name, cluster label etc.) This size also modifies horizontal space between CI elements. Applied to map view and exported PDF view. Not applicable to network/storage path maps. sncCommonMap.NODE_LABEL_WIDTH | • **Type**: integer  
• **Default value**: 95  
• **Other possible values**:  
  • Min value: 20  
  • Max value: 1000 |
| Identification Engine Logging: Service cache severity level             | Identification Reconciliation Engine (IRE) logging can help troubleshoot IRE errors related to the creation of application services.  
• **Type**: choice list  
• **Default value**: debug  
• **Other possible values**:  
  • Info  
  • Warn  
  • Error  
  • DebugVerbose  
  • DebugObnoxious  
• **Learn more**: Examine run logs |
| Identification Engine Logging: Identification Engine severity level      | Identification Reconciliation Engine (IRE) logging can help troubleshoot IRE errors related to the creation of application services.  
• **Type**: choice list  
• **Default value**: Debug  
• **Other possible values**:  
  • Info  
  • Warn  
  • Error  
  • DebugVerbose  
  • DebugObnoxious  
• **Learn more**: Examine run logs |
| Enable verbose mode for identification engine                           | Identification Reconciliation Engine (IRE) logging can help troubleshoot IRE errors related to the creation of application services.  
• **Type**: true|false  
• **Default value**: false |

**Baseline CMDB**

CMDB baseline provides capabilities that help you understand and control the changes that have been made to your configuration items (CIs) in the CMDB.
• You can create a baseline, which is a snapshot of your configuration items in the CMDB. You can review the changes that have been made to that configuration item since a previous baseline. Multiple baselines may be created and the system tracks the changes that have been made per baseline.

Creating a baseline captures the attributes of the CI as well as all first-level relationships for the CI. Any changes to the base CI or to any related CIs are captured and displayed. Newly created CIs are not automatically added to a baseline.

• Associate a configuration item with a task, a change or change task, and to propose changes to the CI after the change is complete. You can record changes, and these changes are not applied to the CI immediately but are delayed until the change is complete.

When the change is complete, you can choose to apply the proposed changes which makes all changes previously proposed and associates the changes with the task.

Create a CMDB baseline

You can create a baseline for a CI to track updates to the CI over time.

Role required: ecmdb_admin and itil

1. Navigate to Configuration > Baselines > Baselines.
   If the Baselines module is not visible in the Configuration application, the module is inactive. In that case append /sys_app_module.do?sys_id=f4463879a9fe3dba01b30bc100cbf404 to the instance URL, and in the Module - Baselines form, ensure that the module is Active.
2. Click New.
3. Enter a Name for the baseline.
   By default, the cmdb_ci table is selected so that the record creates the baseline for all configuration items in the system.
4. Optional: To limit the baseline to specific CIs, select a different Table or choose Conditions that a CI must meet for it to have a baseline entry.
   For example, you might create a baseline for the Database table with the condition [Location] [is] [configured location].
5. Click Submit.
   The creation of a baseline is time consuming and occurs in the background. A message at the top of the record list notifies you that your baseline has been scheduled and you will receive an email when the process is complete.

Display baseline differences

You can see the changes that have been made to a CI or any first level related CIs by configuring the CI form layout to display the CMDB Baseline diff field. This field is labeled Baseline differences on the form.

Role required: itil

Changes are displayed only for the cmdb_ci table and child tables. You can change the com.cmdb.baseline.max_changes system property to limit the number of relationships and changes that appear in a baseline diff section on a CI form (set to 100 by default).

1. Open a CI record.
2. Select the baseline you want to see for this CI from the choice list. The field displays the details of any changes that were made to the current record for the selected baseline, or indicates that no changes were made.

<table>
<thead>
<tr>
<th>Details of baseline differences</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Baseline differences</strong></td>
</tr>
<tr>
<td><strong>Basic attribute changes</strong></td>
</tr>
<tr>
<td><strong>2009-09-14 14:46:49</strong></td>
</tr>
<tr>
<td>System Administrator</td>
</tr>
<tr>
<td>Changed: RAM (MB), Disk space (GB)</td>
</tr>
<tr>
<td>RAM (MB): 4 was: -1</td>
</tr>
<tr>
<td>Disk space (GB): 500 was: 100</td>
</tr>
</tbody>
</table>

3. To add a relationship to the CI, click the green plus icon in the Related Items toolbar. The new relationship appears below the toolbar. For more information about the Related Items toolbar and how to control the display, see CI relations formatter.

4. Update a related CI and see the changes displayed as Basic attribute changes in the current CI record.

<table>
<thead>
<tr>
<th>Details of baseline differences</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Baseline differences</strong></td>
</tr>
<tr>
<td><strong>Basic attribute changes</strong></td>
</tr>
<tr>
<td><strong>2009-09-14 15:17:42</strong></td>
</tr>
<tr>
<td>System Administrator</td>
</tr>
<tr>
<td>Changed: Sys audit, RAM (MB), Disk space (GB)</td>
</tr>
<tr>
<td>Storage Area Network 002 was: (relationship added) - CI Relationship Change</td>
</tr>
<tr>
<td>ApplicationServerPeopleSoft was: (relationship added) - CI Relationship Change</td>
</tr>
<tr>
<td>RAM (MB): 4 was: -1</td>
</tr>
<tr>
<td>Disk space (GB): 500 was: 100</td>
</tr>
</tbody>
</table>

### Properties for baseline CMDB

Use the baseline CMDB properties to configure how many changes and relationships for a CI can appear in the baseline diff for the CI.

These properties are available for baseline CMDB. To view and edit these properties, the admin role is required.

**Properties for Baseline CMDB**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum number of changes and relationships for a CI that can appear in the baseline diff for the CI. | - Type: integer  
- Default value: 100  
- Location: Configuration > CMDB Properties > Baseline Properties |
Managing proposed changes

The proposed changes feature allows you to pre-configure changes to configuration items and their associated relationships. These pre-configured changes are prepared to be implemented, but do not actually happen until they are applied at a later time.

When you view a CI, the proposed changes can be displayed so that you can see what is planned.

This feature is useful when you want to make modifications while a change process is in the approval stage, and only implement the changes after the approvals are complete. If the change is never approved, no changes to records have to be reversed. If the change is approved, a quick command applies all the proposed changes.

You can make the following proposed changes to a CI:

- Modify any field on the CI form.
- Add or delete a relationship to that CI.

To modify a relationship, you must delete the current relationship and add a new relationship. You cannot delete a proposed change.

View CI history

You can view the history of changes to a CI in a list, calendar, or timeline format.

View the proposed changes of a CI

You can view the proposed changes so that you can see what is planned for the CI.

Role required: personalize_form

To view any proposed changes, configure the CI form layout to display the CMDB Scheduled Changes field. Proposed changes are not displayed in a CI form by default.

1. Navigate to Change > Open and open a change request.
2. In the Affected CIs related list, open the Configuration Item.
   You may also navigate directly to the CI form.
3. Right-click the form header bar.
4. Select Configure > Form Layout.
5. Move the CMDB Scheduled Changes field to the Selected pane.
6. Click Save.
   The CI form shows the details of any proposed changes in the Scheduled changes area.

Add a proposed change to a CI

Proposed changes to a CI can be made while viewing a change request or any task-related record.

Role required: itil

1. In the Change Request form, go to the Affected CIs related list.
   If there are no CIs in the Affected CIs list, click Edit to add CIs that are affected by this change request.
2. Right-click the CI that you want to configure for a proposed change, and select Proposed Change.
3. Complete the form to make the proposed changes, and click Save Proposed Change.
   Click Update to apply the changes immediately. Click Delete to delete the CI.
4. To propose an addition or a removal of a CI relationship:
   a) Click the plus icon in the Related Items section.
   b) In the Relationships section, add or delete a relationship. For information about using the
      relationship editor, see Create or edit a CI relationship.
   c) Click Save Propose Change.
   d) Confirm saving the proposed change.

   Click Update or Delete to commit the changes immediately.

   **Note:** Use only with CI relationships. Proposing additions or removal of relationships is not
   valid for user relationships and group relationships.

After the proposed changes are saved, the Apply Proposed Changes button appears on the Change Request form. This button lets the user commit the proposed changes to the CI. Your business processes determine the appropriate time to commit the changes. The CI retains the existing data until the proposed changes are committed. However, users can see that changes have been proposed.

**Apply a proposed change to a CI**

When you apply the proposed changes, all the proposed changes for that change request are applied to the configuration item. You can apply proposed changes without verification, or if verification tests of the proposed changes have failed.

Role required: itil

After you apply the proposed changes, the Scheduled changes part of the form displays No scheduled changes found. You can configure proposed change verification rules which you can use to verify proposed changes before applying the changes.

1. Navigate to the Change Request form.
2. Click the Apply Proposed Changes button.

   You may have to right-click the form header and select the Reload Form option to see the changes.

**Create or edit a proposed change verification rule**

Ensure that proposed changes meet business requirements and do not introduce invalid data to the CMDB, create a rule that includes a script to verify the proposed changes.

Role required: asset or itil

When you configure proposed change verification rules for a CI, you have an option to verify that the proposed changes pass the verification test script in the rule. The verification test results are logged as passed or failed, and you can view the results. Running the verification test is not mandatory, and a failed verification test does not prevent you from applying proposed changes.

1. Navigate to Configuration > Change Verification > Proposed Change Verification Rules.
2. Click New or select an existing rule to edit.
3. Fill in the fields, as appropriate.

**Proposed Change Verification Rules form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule name</td>
<td>The name of this rule.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table name</td>
<td>The table to which the rule applies.</td>
</tr>
<tr>
<td>Filter condition</td>
<td>Conditions to apply this rule to specific CIs.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate this rule.</td>
</tr>
<tr>
<td>Rule script</td>
<td>A verification Java script that needs to return true or false. For example:</td>
</tr>
</tbody>
</table>
|                 | ```java
|                 | validateRule()
|                 | {                     
|                 |   var os =
|                 |   current.getValue("os");
|                 |   var cpu =
|                 |   current.getValue("cpu_count");
|                 |     //Use
|                 |     current.getValue(fieldName)
|                 |     to get the proposed
|                 |     change value, eg. var os =
|                 |     current.getValue("os");
|                 |     //Your verification code
|                 |     if (os != "SunOS" || cpu < 2)
|                 |     return false;             
|                 |     //Return true to pass the
|                 |     verification and false if the
|                 |     verification failed
|                 |     return true;             
|                 | }                           |

4. Click **Submit** or **Update**.

On the **Change Request** form, you can click **Verify Proposed Changes** to verify proposed changes for the affected CIs.

**Verify proposed changes**

Before applying proposed changes to affected CIs, use proposed change verification rules to verify that the changes meet business requirements and do not add invalid data to the CMDB.

Create or edit the rules used to verify proposed changes. For details, see [Create or edit a proposed change verification rule](#).

Role required: none

You can apply proposed changes even if they are unverified or fail a verification test.

1. Open the **Change Request** form that affects the CI.
2. Click **Verify Proposed Changes**.
   - The proposed changes are verified against any proposed change verification rules in which the CI meets the **Filter condition** criteria.
3. Review the message that appears at the top of the form after the verification process is finished.
   - The message states whether the verification tests passed or failed.

To view the details of any verification tests that were performed for the change request in the past two days, click the **Proposed Change Verification Log** related link.
Create or edit a planned change validation script

Create a custom script that checks if a change to a class was valid according to business requirements, and whether the change was planned or not. A planned change validation script is used whenever a CI change is viewed in the CI timeline or change history.

Role required: admin or itil

The system attempts to validate each CI change as follows:

• If a custom script exists for the CI or one of the CI parents, then the script is executed and the results are used to flag the change as valid or invalid. Parent CIs are examined in the hierarchical order.
• If a custom script does not exist for the CI or any of its parents, then a predefined validation script is used. The change is determined as a planned change if the change occurred between the Work start and Work end dates of the change request associated with the changed CI.

However, this check is not always reliable because a user might have manually modified the CI within the work dates, which flags the change as valid even if it is invalid.

The script needs to return a boolean, true or false, which depends on meeting the test criteria in the script. You can define a separate script for each CI class, and you can define multiple planned change validation scripts for a single class. For example, to maintain different versions of the script. Only one script can be active for a CI class at any given time.

These are the parameters that uniquely characterize a change:

• The fields that were changed
• The data source that performed the change
• The time stamp of the change

To correctly determine the validity of a change, examine the parameters and apply business logic to evaluate if the validation tests are met. A planned change validation script can test any of these characteristics and determine when a change meets pre-established criteria. For example, the custom script can check if the mode of the CI is operational or maintenance, or who initiated the change.

1. Navigate to Configuration > Change Verification > Planned Change Validation Script.
2. Click New or select a validation script to edit.
3. Complete the form.

Planned change validation script form

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box to activate this script for validating changes.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Class that this script applies to.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to run to validate a change. If the script does not return a boolean value, then it is configured to false.</td>
</tr>
</tbody>
</table>

The script has a template which displays the input variables of the script.

Template script input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>current</td>
<td>GlideRecord</td>
<td>Current record that is being processed.</td>
</tr>
<tr>
<td>Variable</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>updatedOn</td>
<td>GlideDateTime</td>
<td>Time stamp of the change.</td>
</tr>
<tr>
<td>updatedBy</td>
<td>String</td>
<td>Entity responsible for the change.</td>
</tr>
<tr>
<td>fieldsChanged</td>
<td>String</td>
<td>Comma-separated list of the names of all fields that were changed.</td>
</tr>
</tbody>
</table>

This sample script checks who initiated the record update. It returns true if admin initiated the record update. Otherwise, the script returns false.

```javascript
isValidChange();

function isValidChange(/*GlideRecord current, GlideDateTime updatedOn, String updatedBy, String changedFields*/) {
    // Return true if the user that updated the record has an admin role
    return isUserAdmin(updatedBy);
}

function isUserAdmin(userName) {
    var grUser = new GlideRecord("sys_user");
    grUser.addQuery('name', userName);
    grUser.query();
    if(grUser.next()) {
        var roles = new GlideRecord("sys_user_has_role");
        roles.addActiveQuery();
        roles.addQuery('user', grUser.sys_id);
        roles.query();
        while(roles.next()) {
            if(roles.role.name == 'admin')
                return true;
        }
    }
    return false;
}
```

4. Click Submit.

### CI relationships in the CMDB

The CMDB, in contrast to a static asset list, helps you track not only the configuration items (CIs) within your system, but also the relationships between those items.

A relationship in the CMDB consists of two CIs and a relationship type:

- Parent CI
- Child CI
- Type of the relationship that links both CIs

For example, in the [Server1] [Managed by] [Server2] relationship:

- Server1 is the child CI
- Server2 is the parent CI
• [Managed by] is the relationship type

For example, a web application might read data from an instance of Oracle, which in turn might depend on a piece of underlying hardware. Most CIs in a CMDB have multiple relationships to other CIs, users, and groups.

The relationships between CIs can be automatically discovered. If you use Discovery, many relationships can be automatically loaded into the system through the discovery process. If you import your data from another system, you get some form of relationships.

You can add to automatically discovered relationships, create relationships, or edit relationships for a CI by launching the CI relationship editor from the CI form.

Dependent and non-dependent relationships

Dependent relationships, such as tomcat RunsOn Hardware, are used by the Identification and Reconciliation Engine (IRE) to identify dependent CIs. Dependent relationships should not be directly deleted because they are used for CI identification.

Non-dependent relationships are not used for CI identification, and therefore can be deleted if no longer needed.

Suggested class relationships

The system keeps a table (Suggested Relationship [cmdb_rel_type_suggest]) of relationship types that are appropriate for a CI type, based on its class. You can manage suggested relationships by navigating to Configuration > Suggested Relationships, or in the CI Class Manager.

Suggestion model

The relationship editor has a base CI. The base CI designates the CI that a user was on before launching the editor, as the base CI in the new relationship. If you launched the relationship editor from the Inx100 CI, then Inx100 becomes the base CI. Also, every CI in the system has a type (class). For example, bond Inx100 is of the Linux server type.

Many CI types are children of other types in the hierarchy. For example, the class hierarchy for a Linux server is:

```
cmdb_ci -> cmdb_ci_computer -> cmdb_ci_server -> cmdb_ci_linux_server
```

The suggestion model works by analyzing the suggested relationship table for all relationships whose base class is the current base class of the user or any one of its parent classes. For example, looking at a Linux server, the suggestion model would retrieve any relationships whose base class was:

```
cmdb_ci_linux_server, cmdb_ci_server, cmdb_ci_computer, or cmdb_ci
```

The system automatically adds relationships that are used in Service Mapping and Discovery (if activated), to the Suggested Relationship table.

Suggested CI relationships in the relationship editor

The CI relationship editor uses the suggestion model to help users select reasonable relationships for configuration items.

For example, consider these relationship types in the system:

• Provides Power for :: Receives Power From
• Runs on :: Hosts

Typically, a user uses these relationships to define the following reasonable relationships between two items as follows:
• a database runs on a server
• a rack provides power for a server

Typically, neither of the following definitions would be appropriate:
• a rack runs on a server
• a server runs on a database

**Add a suggested relationship**

Add a suggested relationship for a class. The list of suggested relationships for a class is available when you create a new relationship for a CI of that class.

Role required: To view — itil. To create, update, or delete suggested relationships — itil_admin.

1. Use the CI Class Manager (Role required: itil_admin):
   a) Navigate to **Configuration > CI Class Manager**.
   b) Click **Hierarchy** to expand the CI Classes list. Then select the class to add a suggested relationship to.
   c) In the class navigation bar, click **Suggested Relationships**.
   d) Click **New**.
   e) In the Add Suggested Relationship dialog box, select a **Relationship** and a **Target Class** for the relationship. **This Class** and the **Target Class** become parent or child in the suggested relationship, based on your selection of the **Relationship**.
   f) Click **Save**.

2. Or, navigate to **Configuration > Relationships > Suggested Relationships** (Role required: admin):
   a) Click **New**.
   b) Complete the form.

**Suggested Relationship fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base class</td>
<td>The base class in the relationship, which depending on the relationship type, is either the parent or the child in the relationship.</td>
</tr>
<tr>
<td>Relationship</td>
<td>Relationship type.</td>
</tr>
<tr>
<td>Dependent class</td>
<td>The dependent class in the relationship, which depending on the relationship type, is either the parent or the child in the relationship.</td>
</tr>
</tbody>
</table>
Suggested relationship you can add

<table>
<thead>
<tr>
<th>Base Class</th>
<th>Relationship</th>
<th>Dependent/Target Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle</td>
<td>Is Hosted On</td>
<td>Linux Server</td>
</tr>
<tr>
<td>Oracle</td>
<td>Is Hosted On</td>
<td>Solaris Server</td>
</tr>
</tbody>
</table>

Note: The same parent class and relationship can appear more than once.

You may need to delete a suggested relationship, for example, to limit the choice of available relationships in the CI relationship editor. Removing a suggested relationship does not affect relationships that are created or updated by Discovery.

Relationship governance rules

Relationship governance rules is a set of relationship rules used to ensure consistency and validity in modeling relationships between configuration items (CIs) in the CMDB. Use relationship governance rules to prevent the selection of relationship types or directions that are not allowed between specific CI types.

Different applications such as Discovery and Service Mapping, create relationships between CIs. Each application might use inconsistent relationship type or direction to represent the same entity, resulting in multiple views of the same CIs. Relationship governance rules define what are valid relationship types and valid directions between pairs of CI types resulting in valid and consistent relationships in the CMDB.

Relationship governance rules consist of:

- **CMDB dependent relationship rules**: Rules (hosting and containment rules) that are used for CI identification. You can view and modify dependent relationship rules in the CI Class Manager, after selecting a class from the class hierarchy and clicking **Dependent Relationship**.
- **Suggested relationships**: Rules that are based on existing suggested relationships in the Suggested Relationship [cmdb_rel_type_suggest] table. Suggested relationships are used in the CI relationship editor. You can view and modify suggested relationships in the CI Class Manager, after selecting a class from the class hierarchy and clicking **Suggested Relationships**.
- **Reference rules**: Rules that are used mostly by Cloud Management to represent all the possible valid combinations of pairs of referencing and referenced CIs in the service definition.
- **Built-in valid relationships**: The following relationships are pre-defined in the base system as valid relationships:
  - `cmdb_ci_endpoint -> Applicative Flow To::Applicative Flow From -> cmdb_ci_endpoint`
  - `cmdb_ci_endpoint -> Implement End Point To::Implement End Point From -> cmdb_ci`
  - `cmdb_ci -> Use End Point To::Use End Point From -> cmdb_ci_endpoint`

General behavior

- Relationship governance rules support inheritance.
  
  For example, suppose that the suggested relationship `cmdb_ci_appl Runs On::Runs cmdb_ci_hardware` exists. Then a `Runs On::Runs` relationship between a `cmdb_ci_appl_dot_net CI` and a `cmdb_ci_windows_server CI` is valid. That is because .Net Application class inherits from the Application class and the Windows Server class inherits from the Hardware class.
- Duplicate relationship governance rules are not allowed.
- Relationship governance rules are not domain separated.
• It is allowed to have more than one relationship type between the same two CI types.
   For example, the following relationships are valid:
   • `cmdb_ci_appl Depends On::Used by cmdb_ci_service`
   • `cmdb_ci_appl Receives data from::Sends data to cmdb_ci_service`

**Reports**

A relationship between CIs is considered valid if it conforms to any of the relationship governance rules. Use the CMDB dashboard to view reports about overall relationships health including relationships compliance with relationship governance rules. The 'Relationships not compliant with all relationship rules' report shows CI relationships that are not compliant with any of the relationship governance rules.

**CI relations formatter**

The default CI form includes a CI relations formatter from which you can examine a CI and its relationships in various views. From the CI relations formatter, you can also launch the CI relationship editor for the CI.

If the domain separation plugin is activated, then only relationships in which the logged on user is authorized to view both CIs, are displayed.

The CI relations formatter contains a list of related CIs and a toolbar with controls for viewing the relationships between the current CI and related CIs. You can configure the controls in this formatter to modify varying aspects of the view. For more information about formatters, see Create a formatter and add it to the form.

**Note:**

• If an endpoint is a child in one relationship and the same endpoint is a parent in another relationship, then that endpoint is hidden and does not appear in the relations formatter view. Similarly, relationship qualifier chains are also hidden and do not appear in the relationship formatter view.
  
  • Example: CI1 > endpoint > CI2
    In this example, CI1 is related to CI2 through relationships with endpoint. A single relationship appears in the relations formatter:
    CI1 > CI2 (These relationships appear as a direct relationship without endpoint, because endpoint is a parent in one relationship and a child in another relationship)
  • Example: CI1 > endpoint1 > CI2 > endpoint2
    Two relationships appear in the relations formatter:
    CI1 > CI2 (endpoint1 is hidden because it is a parent in one relationship and a child in another relationship)
    CI1 > CI2 > endpoint2 (appears as level 2 relationship – endpoint1 is hidden and endpoint2 appears as it a child and not a parent in any other relationship)

• On instances that do not meet the internet browser requirements for the CI relations formatter, the default CI form includes the legacy CI relations formatter instead. For more information, see Legacy CI relations formatter.
• CIs not extended from the Configuration Item [cmdb_ci] table, are not displayed in Dependency Views maps and in CI relation formatters.
• The **Applicative Flow To::Application Flow From** relationship is a special relationship type used only between Service Mapping endpoints. This relationship type is not intended for use
in the CMDB as a relationship between CIs and therefore it is not displayed in the relations formatter.

Controls for viewing related CIs

<table>
<thead>
<tr>
<th>Control</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add CI relationship</td>
<td>Starts the relationship editor to manually create CI relationships. For more information, see Create or edit a CI relationship.</td>
</tr>
<tr>
<td>Show dependency views</td>
<td>Launches a Dependency Views map in another window or tab. The CI is the central node in the map, with a configurable number of levels above and below that node in the hierarchy. Map indicators next to the nodes indicate the number of tasks, incidents, problems, changes, or outages related to that node. Right-click to expand collapsed nodes or display a list of related tasks or problems. For more information, see Dependency Views map.</td>
</tr>
<tr>
<td>Search for CI</td>
<td>Filters the CIs included in the display.</td>
</tr>
</tbody>
</table>

Click the **Settings** icon to configure additional view settings that filter the data displayed. Settings are preserved through logging out and logging back in.

**Related items settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Relations in Flat/Tree Layout</td>
<td>To view a flat list of related CIs that are grouped by relationship type in alphabetical order, click <strong>Flat</strong>. To view groups of related CIs in a hierarchical tree, click <strong>Tree</strong>. If you select the tree view, you cannot configure any other settings for viewing related CIs. A single list of upstream and downstream relationships is displayed.</td>
</tr>
<tr>
<td>Show Relations in Split/Merge Layout</td>
<td>To view separate lists for upstream and downstream relationships, click <strong>Split</strong>. To view a single list that includes both upstream and downstream relationships, click <strong>Merge</strong>. Relationships are grouped by relationship type.</td>
</tr>
<tr>
<td>Filter Relations by Max Level</td>
<td>Select the number of levels in the hierarchy to include when displaying CIs in a flat view.</td>
</tr>
<tr>
<td>Filter Relations by Relationship Type</td>
<td>Select the types of relationships to view.</td>
</tr>
<tr>
<td>Filter Relations by CMDB View</td>
<td>Filter by tables specified in CMDB views, if any relationship filters exist.</td>
</tr>
</tbody>
</table>
The relations formatter uses the following icons to provide additional information about changes, problems, and outages related to CIs in the relationship:

**Icons related to CIs**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt=" recently closed changes icon " /></td>
<td>Recently closed changes</td>
</tr>
<tr>
<td><img src="image" alt=" planned changes icon " /></td>
<td>Planned changes</td>
</tr>
<tr>
<td><img src="image" alt=" currently open changes icon " /></td>
<td>Currently open changes</td>
</tr>
<tr>
<td><img src="image" alt=" recently closed outages icon " /></td>
<td>Recently closed outages</td>
</tr>
<tr>
<td><img src="image" alt=" problems icon " /></td>
<td>Problems</td>
</tr>
<tr>
<td><img src="image" alt=" incidents icon " /></td>
<td>Incidents</td>
</tr>
<tr>
<td><img src="image" alt=" planned outages icon " /></td>
<td>Planned outages</td>
</tr>
<tr>
<td><img src="image" alt=" currently open outages icon " /></td>
<td>Currently open outages</td>
</tr>
</tbody>
</table>

In large networks, a list of related CIs might be excessively long, which can slow performance when a CI form is rendered. You can configure these properties to control the amount of data that is displayed. To find a property, enter `sys_properties.list` in the left navigation filter and search for the property.

**Properties related to performance**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>glide.ecmdb.find_relationship_issues</code></td>
<td>Hides or displays an icon in the CI relations formatter that links to open issues for the CI. This property defaults to true (displays the icon).</td>
</tr>
<tr>
<td><code>glide.ui.max_relation_levels</code></td>
<td>Specifies the maximum level for displaying CIs in flat view before reaching the maximum relations limit. The default value is 5.</td>
</tr>
<tr>
<td><code>glide.ui.max_relations</code></td>
<td>Specifies the maximum number of related CIs to display. When exceeded, a notification is displayed indicating that the limit has been reached, and that not all relations are displayed. The default value is 1000.</td>
</tr>
</tbody>
</table>

**Domain separation in the relations formatter and the CI relationship editor**

This is an overview of domain separation as it pertains to the relations formatter and the CI relationship editor. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.
Overview

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

How domain separation works in the relations formatter and relationship editor

• Relations formatter
  The relations formatter is domain-separation supported. The relations formatter is used to display CMDB relationships in the UI in different views. Since the CI Relationship (cmdb_rel_ci) table is not domain separated, relationships are visible in the relations formatter only if both parent and child CIs (cmdb) are visible in the domain.
  
The CI Relationship Type (cmdb_rel_type) table is not domain separated. Therefore, in the relations formatter, all the relationship types are available to be selected as a filter.
  
  By default domain separation is supported in the relations formatter.

• Relationship editor
  The relationship editor is domain-separation supported. You can use the relationship editor to add new relationships or delete existing relationships for the current CI.
    • The CI relationship editor displays a list of CIs to add or remove from relationships. Since they are domain separated, the CI list view in the relationship editor displays the CIs that are visible to the current domain.
    • The CI relationship editor displays a list of relationships to add or remove. Since the CI Relationship [cmdb_rel_ci] table is not domain separated, the relationships list view displays all the relationships of the current CI.

  The Suggested Relationship (cmdb_rel_type_suggest) table is not domain separated, which means that all the suggested relationship types in the relationship editor are visible for all domains.
  
  By default domain separation is supported in the relationship editor.

Create or edit a relationship filter

Create a custom relationship filter to display CI relationships from selected tables in the CI relations formatter.

Role required: ecmdb_admin

The CI relations formatter displays related CIs for the base CI, and the relationships between the CIs. You can use relationship filters on the CI relations formatter to customize CI relationship views.

1. Navigate to Configuration > Relationships > Relationship Filters.
2. Click New or select a filter to edit.
3. Enter or edit the relationship filter name.
4. Right-click the form header and click Save.
5. In the Configuration Types section, click Edit.
6. On the Edit Members form, select the tables of the CIs that you want to show with the filter and then move the tables to the Configuration Types list.
7. Click Save.

On a CI form, in the relations formatter settings, you can select the newly defined relationship filter from the Filter Relations by CMDB View list.
In the legacy CI relations formatter, you can click View and select the newly defined relationship filter. After you select a filter, the relations formatter displays only CIs from the tables specified in the filter or from descending tables.

Exclude relationships from the relations formatter view
Create a list of relationships that should not appear in the relations formatter view on CI forms.

Role required:
- To view the relationship type exclusion list — itil
- To create, update, or delete the relationship type exclusion list — itil_admin

1. Navigate to Configuration > Relationships > Relationship Type Exclusion List.
2. In the CI Relation Filters list view, click New.
3. Fill out the CI Relation Filter form to specify the relationship that you want to exclude from view.
4. Click Submit.
   Excluded relationships do not appear in Related Items on CI forms.

Legacy CI relations formatter
On instances that do not meet the internet browser requirements for the latest CI relations formatter, the default CI form includes the legacy CI relations formatter instead.

This element contains the list of related CIs and a toolbar with controls for viewing the relationships between the current CI and related CIs.

Related items field

Note: The legacy BSM map provides a more complete view of CI relationships.

Configure the controls in this formatter with two properties that restrict varying aspects of the view.

Flat layout
Click the flat layout icon ( ) to group the related CIs by relationship.
Flat layout view

Tree layout

Click the tree layout icon ( ) to group the related CIs in a hierarchical tree.

Tree Layout View

**CI relationship editor**

Use the CI relationship editor to create CI relationships.

When you use the relationship editor, the CI from which the editor was launched is designated as the base CI. You can then select one or more CIs as a second CI for the relationship. Depending on the selected relationship type, the base CI can become the parent CI or the child CI in the new relationship.

The relationship editor operates differently, depending on whether you select the **Use suggested relationship** check box.
• With suggested relationships, the relationship editor lists all available relationship types for the base CI. To define a new relationship, select a relationship type, and then select a second CI for the relationship.

Suggested relationships are highlighted for you. These relationships are displayed in blue with a prefix of [Suggested].

• Without suggested relationships, you define a new relationship by first selecting a second CI for the relationship and then selecting a parent or a child relationship type.

**Note:** The following relationship types are used only for Service Mapping endpoints, and you cannot use them as a relationship type between two CIs:
- Implement End Point To: Implement End Point From
- Use End Point To: Use End Point From
- Applicative Flow To: Applicative Flow From

**Suggested relationships**

If you select the **Use suggested relationship** check box in the editor, the **Suggested relationship** list appears. It displays all available CI, user and group relationship types for the base CI. Relationship types have a suffix of (Parent) or (Child) to note the relationship descriptor, and suggested relationship types are displayed in blue and have a "*" prefix.

When you select a relationship, you are also designating the base CI as being the parent or the child CI in the new relationship. For example, if you select the 'Feeds' relationship type, the base CI becomes the designated parent CI, and the second CI that you select becomes the child CI in this relationship.

**Downstream relationships**

If you do not select the **Use suggested relationship** check box in the editor, the **Downstream relationships** list appears. It displays all relationships in which the base CI is the parent CI. The child CI of the relationship is displayed in the **Child** column.

**Upstream relationships**

If you do not select the **Use suggested relationship** check box in the editor, the **Upstream relationships** list appears. It displays all relationships in which the base CI is the child CI. The parent CI in each relationship is displayed in the **Parent** column.

**Supported browsers for the relationship editor**

You must use supported browser versions in order to use the latest CI relationship editor. If you do not use a supported browser version, the instance provides the legacy CI relationship builder.

• Firefox version 20 and up
• Chrome version 25 and up
• Safari version 6 and up
• Internet Explorer version 9 and up

**Create or edit a CI relationship**

Use the relationship editor to view, create or modify CI relationships. You can open the relationship editor from the CI Relations formatter.
Role required:

- To create relationships: ITIL or asset
- To view relationships, depending on the state of the Table API ACL:
  - If inactive (default): ITIL or asset
  - If active: ITIL or asset, and snc_platform_rest_api_access

For more information, see REST API and Table API.

The relationship editor operates differently, depending on whether you check the **Use suggested relationship** option or not.

1. Launch the relationship editor:
   a) Open a CI form.
   b) Locate the **Related Items** section near the center of the form.
   c) Click the plus (+) icon on the **Related items** section.
2. To use suggested relationships, first select a relationship type, and then select one or more CIs to be the child CIs in the relationship:
a) Select **Use suggested relationship**.

b) From the **Suggested relationship type** list, select a relationship type.

You can filter the list of suggested relationships by using the filter check boxes.

<table>
<thead>
<tr>
<th>Filter option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide CI relationship</td>
<td>Hides any relationships between the base CI and another CI (such as &quot;Receives data from&quot;). Default filter is stored in the ci_manage_relationships_filter_hint.cmdb_ci user preference.</td>
</tr>
<tr>
<td>Hide user relationship</td>
<td>Hides any relationships between the base CI and a user (such as &quot;Logs reviewed by&quot;). The default filter is stored in the ci_manage_relationships_filter_hint.sys_user preference.</td>
</tr>
<tr>
<td>Hide group relationship</td>
<td>Hides any relationships between the base CI and a group (such as &quot;Backups done by&quot;). Default filter is stored in the ci_manage_relationships_filter_hint.sys_user_group user preference.</td>
</tr>
</tbody>
</table>

The **Configurations Items** list displays all the CIs that are appropriate for the base CI and the selected relationship type. The **Relationships** list at the bottom of the editor, displays all existing relationships of the selected relationship type, in which the base CI is a parent CI or a child CI.

c) From the **Configuration Items** list, select one or more CIs as a second CI for the relationship.

You can filter the list of **Configurations Items** by adding conditions in the **Filter** section and clicking **Run filter**.

If you selected a parent relationship type, these CIs becomes the child CI in the relationship, and if you selected a child relationship type, then the selected CIs become the parent CI in the relationship.

d) In the **Relationships** section, click the plus icon (+) to add the new relationships.

Alternatively, you can drag the selected CIs to the **Relationships** list. Each new relationship will consist of the base CI, the selected relationship type, and a selected second CI.
3. To not use suggested relationships, first select one or more CIs to be the child CIs in the relationship, and then select the relationship type:

a) Clear **Use suggested relationship**.

b) In the **Configuration Items** list, select one or more CIs as a second CI for the relationship. You can filter the list of **Configurations Items** by adding conditions in the **Filter** area and clicking **Run filter**.

   Depending on the relationship type that you will select, the selected CIs might become a parent or a child CI in the relationship.

c) With at least one CI selected in the **Configuration Items** list, click the ‘+’ sign in the **Downstream Relationships** section or the **Upstream Relationships** section to create the relationship.
• Add the relationship to **Downstream Relationships** to create a relationship in which the base CI is the parent CI and the selected CI is the child CI.
• Add the relationship to **Upstream Relationships** to create a relationship in which the base CI is the child CI and the selected CI is the parent CI.

d) For each newly created relationship in either the **Downstream Relationships** or the **Upstream Relationships** lists, click **Please select a relationship** and select a relationship type.

• The list of available relationship types in the **Downstream Relationships** list contains parent relationships only, in which the base CI is the parent CI.
• The list of available relationship types in the **Upstream Relationships** list contains child relationships only, in which the base CI is the child CI.

e) Click **Save** or **Save and Exit**.

Only after you enter all the information that is necessary for creating the relationship, these buttons light up indicating that there are pending updates that require saving.

### Legacy CI relationship builder

Used to define CI relationships manually, this page is a sophisticated version of the standard slushbucket.

In the legacy CI relations formatter, click the CI relationship builder icon (➕) to display the legacy Define Relationships page.

**Select a CI relationship type**

The top half of the legacy relationship editor contains a large option box that allows you to select which type of relationship you want to manipulate. Click the particular type of relationship you are interested in working with.

**Filter the list of CI relationships**

In the legacy relationship editor, the checkboxes along the right hand edge of the select box provide a quick way to filter down the list of available relationships.

By default, the system displays a list of all suggested relationships for the type of CI you selected. For example, if you selected a Database instance, a relationship of “Runs on” makes sense, but a relationship of “Provides HVAC for” does not. The default filter is stored in the user preferences `ci_manage_relationships_filter_hint.cmdb_cici_manage_relationships_filter_hint.sys_user`, and `ci_manage_relationships_filter_hint.sys_user_group`.

- **Hide CI relationship** -- Hides any relationships between this CI and another CI (e.g. "Receives data from").
- **Hide user relationships** -- Hides any relationships between this CI and a user (e.g. "Logs reviewed by").
- **Hide group relationships** -- Hides any relationships between this CI and a group (e.g. "Backups done by").
- **Show all relationships** -- If you have the appropriate role (out of the box this is `itil_admin`) you will have an additional checkbox labeled "Show all relationships." If you click that checkbox, the system will let you choose any relationship defined in the system, regardless of where it is on the "suggested" list for this type of CI.
Select CI relationship targets

In the legacy relationship editor, users can link or unlink CIs for a relationship type.

As soon as you pick a relationship type, the system will fill in the two select boxes at the bottom of the screen with CIs's that are appropriate for the relationship you suggested. The left hand select box will contain a list of CI's that might reasonably be linked via this relationship, while the right hand box contains a list of those CI's which are already linked.

1. Link or unlink items.

<table>
<thead>
<tr>
<th>Link new items</th>
<th>Move that CI from the left hand box to the right hand box.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlink existing items</td>
<td>Move them from the right hand box to the left.</td>
</tr>
</tbody>
</table>

**Result:** When you make either type of change, a message appears indicating that you have pending changes.

2. Apply or cancel your changes.

<table>
<thead>
<tr>
<th>Click the Save button.</th>
<th>This will save your set of changes, and go back to the previous screen (either a CI or the BSM map depending on how you got here).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Cancel button.</td>
<td>This causes you to exit without saving your changes.</td>
</tr>
</tbody>
</table>

Relation qualifier

A relation qualifier, which is a CI of the Qualifier [cmdb_ci_qualifier] type, stores important information about the CI relationships.

In a relation qualifier, you can annotate arbitrary unique information about the relationship between two CIs. You can define multiple qualifiers for a single relationship, resulting in a qualifier chain. But, there can be only a single qualifier chain for a specific relationship type between two CIs.

For example, for a relationship between a parent CI and a child CI, you can add a relation qualifier to note that the relationship was discovered based on traffic (such as cmdb_ci_qualifier_trafficbased). This results in having two records in the CI Relationship [cmdb_rel_ci] table for the relationship.

- A record that links the parent CI and the new qualifier
- A record that links the new qualifier and the child CI

For this relationship, there is a parent CI and a child CI, and a relation qualifier of type cmdb_ci_qualifier_trafficbased.

For information about usage of relation qualifiers in the identification process, see CMDB identification rules.

CI relationship security

When applying security to CI relationships, it is important to apply the access controls both to the CI Relationship (cmdb_rel_ci) table and to create an operation editCIRelations to the * table as well.

If the current instance has defined security for editCIRelations, it will be applied to edit_ci_relations automatically in the process of upgrading, and the out-of-date security will be removed.
Create a CI relation rollup

A CI relation rollup allows you to sum, count, max, min, or mean a relationship type. You can create CI relation rollups.

Role required: ecmdb_admin

CI relation rollup can be useful for tracking and for receiving notifications. For example:

- In a sum roll up, add up fields from multiple CIs and display the result on another CI to which they are related. So, if you have four configuration items in a rack that are all consuming power, create a CI relation rollup to add all the power usage together and display the result in one field on the rack CI form.
- If a certain level of power consumption in a rack is exceeded, send a notification.
- With a rack that has 10 slots, send a notification when 9 slots are filled.

CI relation rollups use the `cmdb synch event` business rule on the `[cmdb_ci]` table. Although this business rule is active by default, you must modify the rule slightly before it will run.

1. Navigate to Configuration > Relationships > CI Relation Rollups.
2. Click New.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Relationship Type</td>
<td>Select a relationship type from the list to use with the rollup. For example, Members::Member of contains the parent descriptor Members and the child descriptor Member of.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of rollup from the drop-down list: COUNT, MAX, MEAN, MIN, or SUM.</td>
</tr>
<tr>
<td>Parent field</td>
<td>The target field on which the operation will be done.</td>
</tr>
<tr>
<td>Child field</td>
<td>The input to the equation type. The Parent field is affected by the selections in the child field.</td>
</tr>
<tr>
<td>Rollup class</td>
<td>The classes that can use the relationship. For example, you can specify that the relationship only applies to racks.</td>
</tr>
</tbody>
</table>

4. To run the `cmdb synch event` business rule, navigate to Business Rules.
5. Use the search box to find the `[cmdb synch event]` table.
6. Click the `cmdb synch event` business rule to go to the Business Rule page.
7. Select the Update, Delete, and Query check boxes.
   Additionally, if you wish CI relation rollups to recalculate when there is a change to a relationship, use a similar procedure to select the Active check box on the `cmdb_rel_ci synch event` business rule.

CMDB classifications

CMDB classifications are groups of configuration items (CIs) that share attributes and are stored in their own table. Classifications allow administrators to define the hierarchy of CIs within the CMDB. A CI class refers to the actual table name in the instance database. In that context, CI Type is a friendly name that a CI is known by, such as computer, router, or printer.

As good practice, keep CI classifications as simple as possible.
### CMDB record types

The CMDB contains the following major record types.

<table>
<thead>
<tr>
<th>Record types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item (CI)</td>
<td>Any computer, device, or service in the CMDB. A CI's record includes all of the relevant data, such as manufacturer, vendor, location, etc. Configuration items can be created or maintained either using tables, lists, and forms within the platform, or using the Discovery application.</td>
</tr>
<tr>
<td>Relation Type</td>
<td>A defined relationship between a CI and either another CI, a user, or a group. Relation types are defined twice, once from the perspective of the child CI and once from the parent CI's perspective. For example, a parent CI that powers a child CI uses relation type <strong>Powers::Is Powered By</strong>. Example relation types include <strong>In Rack::Rack contains</strong>, <strong>Log Reviewed by::Reviews logs</strong> for, or <strong>Backup done by::Does backups</strong> for. CMDB relationships can be established using Discovery or using the tables, lists, and forms within the platform. The CMDB form has a specific Related Items toolbar optimized for modifying relationships.</td>
</tr>
</tbody>
</table>

### Related Lists of CI components

Related lists in CI records display additional components contained by that CI, such as disk drives on a server and the rules that control the behavior of a network router.

When Discovery runs, the Related List is populated with the components that Discovery finds running on the CI. The CI record might show different lists from scan to scan, depending on whether or not Discovery found the component.

By default, the Related Lists only display those components that are associated with that CI in the CMDB that have been discovered by the last scan. Components that are recorded in the CMDB but are not discovered in a scan, are deemed absent and do not appear in the list.

There are two types of components that appear in the Related List: those that are CIs themselves (such as hard disks), and those that are not (serial numbers and rules). The default filter condition in the breadcrumbs for components that are CIs is `[Status] [!=] [Absent]`. The filter condition for components that are not CIs is `[Absent] [=] [false]`.

In the following example, the `snc-tc01` router has several Related Lists affected by these filter conditions, including routing rules, disk drives, interfaces, and network adapters. Only those components found during the last Discovery appear in these Related Lists.
Create a CI class

Create a CI class (table) that is an extension of an existing CI class. Then create identification and reconciliation rules for the new class.

The class that is being extended must have its **Is_Extendable** field checked, indicating that the class is extendable.

Roles:

- Itil_admin and personalize_dictionary: Required for editing the dictionary table
- admin: Full access

The CI Class Manager is a centralized location for managing CMDB tables and for creating a class that is derived from another CMDB class. Creating a class requires basic details such as a label and a name. Identification and reconciliation rules are also required to ensure that the class can be successfully identified by the identification engine.

For more information about extending a class and how attributes are derived from a parent class in that process, see **Table extension and classes**.

1. Navigate to **Configuration > CI Class Manager**.
2. Click **Hierarchy** to expand the CI Classes list. Then select the class that the new class is extended from.
3. Click **Add Child Class**.  
   The **Add Child Class** option appears only if the selected class is extendable.
4. On the **Provide Basic Info** tab, fill out the information and then click **Next**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>A unique label for the class (such as Laptops or Thin Clients). The label appears on list and form views for the class. Updating the <strong>Label</strong> field also updates the label record in the language file for the current language. See Field Labels in Data dictionary tables. Maximum string length is 80 characters.</td>
</tr>
</tbody>
</table>
| Table name     | Automatically populated based on the table label and a prefix as follows:  
|                | • For a table in a scoped application, the name is prefixed with a namespace identifier to indicate that it is part of an application.  
|                | • For a table in the global application, the name is prefixed with the string ‘u_cmdb_ci’. This prefix denotes that the table is created by a user in the CMDB.  
|                | You cannot modify the prefix; however, you can modify the rest of the table name. The name can contain only lowercase, alphanumeric ASCII characters and underscores (_). Maximum string length is 80 characters. |
| Description    | Explanation of the use purpose of the class. |
| Icon           | The icon associated with the class. |
| Extensible     | Indicator of whether this class can be extended. |

5. On the **Add Attributes** tab, click the + sign and enter details for each new class column. Then click **Next**. For description of the different columns in the list view, see Dictionary entry form. Set **Identification** to true to designate the column as a CI identifier for class identification.

6. On the **Set Identification Rule** tab, examine the **Derived** identification rule and its **Identifier Entries**. You can click **Replace** to replace the derived rule with a new identification rule and new identifier entries specific to the new class. See Identification rules for details about identification rules and identifier entries.

7. On the **Dependencies** tab, click **Add dependency** to add dependent rules. The **Dependencies** tab appears only if there are dependent identification rules for the selected class.

8. On the **Add Reconciliation Rules** tab, click **Add** to create the following rules:
   a) **Reconciliation Rules**
   b) **Data Precedence Rules**
   c) **Data Refresh Rules**
9. On the Add Suggested Relationships tab, review the diagram of the class derived suggested relationships. Use the filter to display only inbound, outbound, or specific relationship types. To add a suggested relationship for the class:
   a) Click New.
   b) In the Add Suggested Relationship dialog box, select a Relationship and a Target Class for the relationship. This Class and the Target Class become parent or child in the suggested relationship, based on your selection of the Relationship.
   c) Click Save.

When building relationships for the class in the Query Builder, the list of suggested relationships is updated.

10. Click Done.

Reclassify a CI
You can upgrade, downgrade, or switch the class of a CI by modifying its Class attribute.

Role required: itil or asset (In general, the roles required to update a CI)

Each class is defined with a unique set of attributes. This set consists of attributes that were derived from the parent class, and additional attributes defined for the class.

When you reclassify a class, the following occurs.

1. The set of attributes is adjusted to match the set of attributes of the newly assigned class. Attributes are added or removed as needed.
2. If any attributes are unique to the current class and are not defined in the newly reclassified class, they are lost.
3. A new record with the CI's current sys_id is inserted to the table of the new class, with the appropriate set of attributes for the class (the sys_id of the CI is retained).

Depending on the reclassification, the following occurs.

Downgrade
The CI class is updated to a class that is higher in the class hierarchy, and the newly assigned class is a parent of the current class. For example, reclassifying a CI from the cmdb_ci_server class to the cmdb_ci_computer class.

For example, the cmdb_ci_server class has attributes that the cmdb_ci_computer class does not have. During the downgrade, these attributes and their respective values are not included in the new CI record that is inserted into the cmdb_ci_computer class.

Upgrade
The CI class is updated to a class that is lower in the class hierarchy, and the newly assigned class is a derived child of the current class and has additional attributes. For example, reclassifying a CI from the cmdb_ci_computer class to the cmdb_ci_server class.

Switch
The newly assigned class is in a different branch in the class hierarchy and has a different set of attributes than the current class. For example, reclassifying a CI from the cmdb_ci_linux_server class to the cmdb_ci_win_server class.
A switch is a combination of a downgrade and an upgrade. For example, if the CI is downgraded to the `cmdb_ci_server`, and then upgraded to the `cmdb_ci_win_server` class. Therefore, attributes are lost in the same manner as in a downgrade operation.

**Note:** Avoid the CI class downgrade and CI class switch operations as those can lead to data loss. When automatic CI reclassification is enabled (which is by default), the identification process can result in some automatic reclassifications which lead to data loss.

For information about CI reclassification by the Identification and Reconciliation Engine (IRE) and related system properties that control the behavior of automatic CI reclassification, see [CI reclassification](#).

1. Locate the CI that you want to reclassify and display it in a list view. You can use the application navigator. Or for example, if the CI is a server, then in the navigation search box, type `cmdb_ci_server.list` to display the CI in the Server view.
2. Ensure that the **Class** field is displayed in the list. If you do not see this attribute, personalize the list to add the **Class** field.
3. Double-click the **Class** value for the CI, and select a new class.
4. Click the green check box to confirm your selection.

### Delete CIs for a CMDB class

You can use the CI Class Manager to delete CIs that are no longer needed.

**Role required:** itil_admin

1. Navigate to **Configuration > CI Class Manager**.
2. Click **Hierarchy** to expand the CI Classes list and then select the class from which you want to delete CI records.
3. In the class navigation bar on the left, click **CI List**.
4. On the CI List form view, select the CIs that you want to delete. Select the check box in the header to select all the CIs that are visible.
5. Click **Actions on selected rows** and then click **Delete**.
6. Click **Delete** in the **Confirmation** dialog box.

### View and edit class definitions and metadata

Use the CI Class Manager as a central location to explore the CMDB class hierarchy, CI table definitions, and class CIs. View the details of each table such as its label and fields, relationships, and all related metadata definitions.

The CI Class Manager displays the entire CMDB class hierarchy in a tree-view format, consolidating class definitions into a central location. It lets you display metadata information for a class, such as reconciliation rules, mandatory and recommended fields, and audit templates. You can also select a specific class to view, to modify, or to extend its definition to create a derived class. For each table, you can directly access CMDB Health settings and rules such as datasource precedence rules, orphan scorecard, and certificate template defined for the table class.

For more information about extending a class and how attributes are derived from a parent class in that process, see **Table extension and classes**.

1. Navigate to **Configuration > CI Class Manager**.
2. Click **Hierarchy** to expand the CI Classes list and then select a class to display details for.
3. On the class navigation bar, expand the following items to display further details for the class.

- **Class Info:**
  - **Basic Info:** Displays details for the selected class, such as the display and table name, description, and class icon. Lets you edit some of the class definitions, and prevents editing of some details such as the table name.
    Role required: itil for reading, and itil_admin and personalize_dictionary for writing.
  - **Attributes:** Displays table attributes (columns). Lets you edit those attributes and add new ones. For description of the different attributes in the list view, see Dictionary entry form.
    Role required: personalize_dictionary and itil for editing, and personalize_dictionary for reading
  
  To add an attribute:
  a. Click the Added tab and scroll to the bottom of the list.
  b. Double-click Insert new column, and enter details for each new class attribute. Set Identification to true to designate an attribute as a CI identifier for class identification.
  c. Click Save, and fix any errors that appear.

- **Identification and Reconciliation:** Displays and lets you edit, create, and delete identification and inclusion rules, reconciliation, data precedence, and data refresh rules for the class.
  See CMDB Identification and Reconciliation for more information.
  Role required: itil for reading, and itil_admin (on top of itil) for writing.

- **Dependent Relationships:** Displays and lets you edit, create, and delete hosting and containment relationships for the class. See CMDB dependent relationship rules for more information.
  Role required: itil for reading and itil_admin (on top of itil) for writing.

- **Suggested Relationships:** Displays a diagram of all suggested relationships for the class, and lets you delete or add suggested relationships for the class. Use the navigation tools to increase or decrease the diagram, and to move the diagram on the page. Use the filter to display specific relationship types. See Suggested class relationships for more information.
  Role required: itil

- **All Relationship Rules:** Displays a combined diagram of all suggested relationships and all dependent relationships for the class. Use the navigation tools to zoom in or out, and to move or center the diagram on the page. Use the filter to display specific relationship categories.

- **Health:** Lets you review and configure CMDB Health-related system properties, scorecards, and rules and settings for all CMDB health KPI and metrics, at the class level. See CMDB Health for information about enabling and configuring CMDB Health, and displaying health reports.
  Role required: Itil for reading and itil_admin (on top of itil) for writing.

- **CI List:** Displays the CIs of the selected class. Lets you create CIs of the selected class and perform other operations such as delete.
  Role required: Itil for reading. Writing requirements follow the selected table settings.

**Querying the CMDB**

The CMDB Query Builder allows you to easily build complex infrastructure and service queries, that span multiple CMDB classes, non-CMDB tables, and that involve many CIs that are connected by different relationships.
The CMDB Query Builder provides a canvas into which you drag the CI classes that you want to include in a query. Then you add relationships, AND/OR operators between the CI classes, and define the relationship properties to query for. You can use saved queries to populate a CMDB group with CIs, and then use scriptable APIs to retrieve the CI list and apply actions collectively to all the CIs in the group.

There are two query types: CMDB Query and a Service Mapping query, which you can use separately or in combination to create queries such as:

- All CIs of a certain type in a business service. For example, all Apaches/Web Servers/Linux servers per service.
- All virtual servers and the physical servers that host them.
- All servers that are not mapped to any business service.
- All Servers with a database.
- All database servers that are included in any business service or in a particular business service.
- All business services and their associated servers and the cost of each server. This query helps evaluate the cost of technology for each business service.

A start node in the Query Builder is the starting point of the query and is noted by gray background in its query node. The first class that you drag to the canvas becomes automatically the start node of the query and you cannot select a different start node. In a complex query, the start node must always be the only node connected to an AND/OR operator. If you try to connect a second node to an operator that the start node is connected to, the query fails to run and a prompt to select a different start node appears.

**CMDB Query**

A query type that queries the infrastructure for CI classes and optionally a non-CMDB table, and the relationships and references that connect them.

When you create a CMDB query, you can add tables from a list of non-CMDB tables. The list of non-CMDB tables includes a subset of tables within the system (such as Asset, Task, and Problem), which have a reference to the Configuration Item [cmdb_ci] class or its children. You can use the system property glide.cmdb.query.non_cmdb.blacklisted_tables to narrow down the list of non-CMDB tables to choose from.

**Service Mapping Query**

A query type that queries business services and technical services, and thus requires that Service Mapping is activated. The query is framed within a business service map. You define a pattern, and query for business service maps that have that pattern in their definition. The relationships in Service Mapping queries are matched by single-level direct relationships which is similar to the CMDB queries, and in addition, they are also matched by multi-level indirect relationships if they exist. A query for a relationship between two CI classes is satisfied even if the two CI classes are connected by intermediate CI classes that are not specified in the query.

**Combination Query**

You can combine the two query types by incorporating a saved Service Mapping query into a CMDB query. For example, create a CMDB query for Windows Servers that are connected to Tomcat WAR. Then connect the Tomcat WAR CI class to a Service Mapping query. The query changes to find Windows Servers that are connected to Tomcat WAR which is included in the services that returned by the Service Mapping query. You can inverse that query by choosing Does Not Belong To Service. This changes the query to find Windows Servers that are connected to Tomcat WAR that is not included in services returned by the Service Mapping query.
Relationship properties

When you connect CI classes on the canvas, the CMDB Query Builder displays the Connection Properties in the right-side bar, where you can configure the properties of the relationship, such as the relationship direction. For Service Mapping queries, you can configure whether to query for related or unrelated CIs.

Connection properties include:

- Relationship type: Query for CIs and descending classes with specific relationship types.
- Relationship direction: Which CI class is the parent and which CI class is the child in the relationship.
- Relationship level: Query only on first-level relationship or also on second-level relationships.
- No relationships: Query for CIs which have no relationship to the set class.
- References fields: A field that the parent and ancestor parent CI classes use to reference the child CI class.

Newly added relationships between CI classes may take up to 30 minutes to appear in the relationship list.

Domain separation in CMDB Query Builder

This is an overview of domain separation as it pertains to the CMDB Query Builder. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

How domain separation works in the CMDB Query Builder

With the CMDB Query Builder you can easily build complex infrastructure and service queries that span multiple CMDB classes, and that involve many CIs that are connected by different relationships. Domain separation is set to be on by default.

- Saved Query
  The user creates a query by dragging a class node from the class hierarchy and dropping it to the canvas and connecting the nodes with the relationships type.
  The user can save the created query as an XML file to the database [qb_saved_query] table in the CMDB for future use. The saved query is domain separated.

- Query results
  With a saved query, the user clicks Run and the query result is saved and displays in the platform list view.
  In the query results, the domain separation behaves in the same way as the platform list view for the CI relationship [cmdb_rel_ci] table and CMDB CI [cmdb] table. Consequently, since the CI relationship is not domain separated, all relationships of the query result display, regardless of the domains. Conversely, if the query result is CI only, since the CMDB CI is domain separated, the results display only if visible in the current domain.
Build a CMDB query using the CMDB Query Builder

A CMDB query type queries the infrastructure for CI classes and optionally a non-CMDB table, and the relationships and references that connect them.

The UI16 plugin (com.glide.ui.ui16) must be activated.

Role required: cmdb_query_builder_read to only view and run saved queries, and cmdb_query_builder (contained for itil, itil_admin, and asset) to create and save queries, modify saved queries, and run queries. Authorized users can update and delete a query created by another user.

Build the query by dragging the CI classes and a non-CMDB table that you want to include in the query. Then dropping them as nodes on the canvas, and defining relationship properties between them. You can filter on the attributes of any node to narrow down the results to a specific set of CIs of that class or to a single specific CI. You can also select which property columns appear in the query results.

As you step through building a query, list options and other user interface elements of the CMDB Query Builder, are dynamically filtered as appropriate to your selections.

1. Navigate to Configuration and click CMDB Query Builder.
2. On the CMDB Query Builder page do either of the following steps:
   - Click Create new. Type in a Name, choose CMDB Query as the Query type, and then click Create.
   - Click a widget of a saved query to continue building an existing query. Search saved queries first if needed.
   - Point to the upper right corner of a saved query widget, and click the Duplicate Query icon to edit a copy of a saved query. The default name of the new query contains the string ‘copy’.
3. On the canvas, you can do any of the following operations:
   
   • Add CI classes to the query: Select classes from the **CMDB Classes** hierarchy list and drag them to the canvas.
   
   • Add a non-CMDB table to the query: Select a table from the **Non-CMDB Tables** list and drag it to the canvas.
   
   **Note:** A non-CMDB table cannot be the start node in the query, and you cannot connect a CMDB class to two non-CMDB tables of the same type.

   • Add connections (relationships) between two nodes on the canvas:
     
     a. On the first node in the relationship, click the small square at the center of the right side.
     
     b. On the second node in the relationship, click the small square at the center of the left side to create the connection.
     
     c. In Connection Properties on the right-side bar, configure the following settings (click the connection line if necessary):
        
        • In the Relationship Direction section, select the **Parent** node (the **Child** node automatically adjusts).
        
        • In the Relationship Levels section, set **Level** to **First level relationships** if the CIs are directly connected. Or, **Up to 2nd level relationships** if the CIs are connected either directly or indirectly through another CI.
        
        • In the Relationship Types and Related Items section, select either option:
   
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Relationships</td>
<td>To query for CIs with no connecting relationships, such as All Tomcat WAR CIs which are not connected to a Windows Server.</td>
</tr>
<tr>
<td>Add Relationship Types</td>
<td>To select specific or any relationship type.</td>
</tr>
<tr>
<td>Add a Related Item</td>
<td>To query for related CIs between the nodes.</td>
</tr>
</tbody>
</table>

   • (Applies only to a non-CMDB table). In the CI Reference Column section, select the column with a reference to a class from the **Reference column to a CI to query on** list. If there is only one option, it is automatically selected.

   **Relationship UI Notations**

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full line</td>
<td>A relationship in a CMDB query.</td>
</tr>
<tr>
<td>Red asterisk at the center of the connection line</td>
<td>Information such as relationship type is missing, invalidating the query.</td>
</tr>
</tbody>
</table>
### Notation

<table>
<thead>
<tr>
<th>Levels:&lt;n&gt; Types:&lt;n&gt; or a &lt;Reference type&gt; notation on the connection line</th>
</tr>
</thead>
<tbody>
<tr>
<td>As applicable: The number of relationship levels and the number of relationship types included for the connection. Or, a reference type for a relationship that is a reference.</td>
</tr>
</tbody>
</table>

- Add filters to a class node: Apply filters to narrow down a class query to a specific set of CIs or to a single specific CI.
  - Point to the node to add a filter to, and then click the **Apply filters** icon that pops up above the node.
  - In the **Filters** section, add attribute and related list conditions.
  - Close the **Filters** section.

  For example: Add a filter for database location to query for databases located in Seattle.

  Click **Applied Filters** in the right-side bar to view all filters for each node on the canvas.

- Add And/Or operators to the query:
  - Connect one node to two other nodes.
  - Click the **And** box that appears on the connection line, to toggle between the **And/Or** operators.

  For example: C1 is Tomcat WAR, C2 is Linux Server, and C3 is Windows Server. Query for all Tomcat WAR CIs which are connected either to Linux Server or to a Windows Server.

- Add property columns for a node, to appear in the query results:

  **Note:** For a relationship, the query results include the parent, child, and type columns. You cannot add any other columns from the [cmdb_rel_ci] table.

  - Click **Properties** in the right-side pane.
  - Click a node once or twice, so that the Report Columns section appears in the right-side bar, and then click **Add Columns**.
  - Select properties and then click outside the properties list to close it.

- Create a combination query by integrating a Service Mapping query into a CMDB query:
  - When building a CMDB query, click **Saved Service Queries** in the left-side bar.
  - Select and then drag a Service Mapping query to the canvas.

  This query returns all CIs that satisfy the CMDB query, and that are included in the services returned by the embedded Service Mapping query.

- Add a search tag that can then be used as a search criteria for saved queries:
  - Click the **Add Tags** icon at the top of the canvas.
  - Click **Add Tag** and in the **Query Tags** dialog box enter one or more tag strings.
  - Click the **Add Tags** icon again to close the **Query Tags** dialog box.
4. Click **Save**.

   On the **Saved Queries** tab, point to a saved query widget and click **Query Information**. Query details such as the query type, last update date, CMDB groups associated with the query, and the query schedules appear.

   • Click **Run**.

   Only the first 100 results of the query appear in the results pane.

   • Click **Load More Results** to view the next set of 100 results.

   • Click **Load All Results** to view the rest of the query results, up to the number specified by the glide.cmdb.query.max_results_limit system property (10,000 by default).

   Click a CI to open its CI form, and on the CI form click **Dashboard** to view CI health in the CI dashboard.

   **Note:**

   • Ensure that the glide.security.use_csrf_token property is set to true, allowing all results to appear.

   • When **Level** is set to **Up to 2nd level relationships**, the relationship type does not appear in the query results.

   • When a query is running, wait for it to complete or to time out before opening or running another query.

   • **Modify Query Builder settings**: Click the **(Settings)** icon to open the **Query Builder Settings** dialog box.

   • Copy and share the URL of a saved query with users that have access to the CMDB Query Builder. Pasting the shared URL in a new internet browser window, directly opens the saved query in the CMDB Query Builder.

   • **Create a report from CMDB query results**.

   • **Create a schedule** to run the query at a future time, and to email the results to interested parties.

   • **Export query results**:

     Click the Query Results context menu and select **Export**. Even if the **Load More Results** button is visible, indicating that there are additional query results, only the results that are visible are exported.

     • **Export and import a CMDB query** to port a query definition between instances.

     • **Populate a CMDB group** using a saved query.

**Build a Service Mapping query using the CMDB Query Builder**

The Service Mapping query type is a pattern consisting of classes and relationships between those classes. After you build the pattern and run the query, the query returns all the Service Mapping services that contain that pattern.

The **UI16 plugin** (com.glide.ui.ui16) must be activated.

Role required: cmdb_query_builder_read to only view and run saved queries, and cmdb_query_builder (contained for itil, itil_admin, and asset) to create and save queries, modify saved queries, and run queries.

Authorized users can update and delete a query created by another user.
Build the query by dragging the CI classes that you want to include in the query, dropping them as nodes on the canvas, and then defining relationship properties between them. For every class node in the query, you can filter on its attributes to narrow down the results to a specific set of CIs of that class or to a single specific CI. You can also select which property columns appear in the query results.

As you step through building a query, list options and other user interface elements of the CMDB Query Builder, are dynamically filtered as appropriate to your selections.

1. Navigate to Configuration and click CMDB Query Builder.
2. On the CMDB Query Builder page do either of the following:
   a) Click Create new. Type in a Name, choose Service Mapping Query as the Query type, and then click Create.
   b) Click on a widget of a saved query to continue building an existing query. Search saved queries first if needed.
   c) Point to the upper right corner of a saved query widget, and click the Duplicate Query icon to edit a copy of a saved query. The new query’s default name contains the string ‘copy’.
3. On the canvas, you can do any of the following:

- Add CI classes to the query: Select classes from the **CMDB Classes** hierarchy list and drag them to the canvas.
- Add connections (relationships) between two nodes on the canvas:
  a. On the first node in the relationship, click the small square at the center of the right side.
  b. On the second node in the relationship, click the small square at the center of the left side to create the connection.
  c. In **Connection Properties** on the right-side bar, configure the following (click the connection line if necessary):
     - In the Relationship Direction section, select the **Parent** node (the **Child** node automatically adjusts).
     - In the Service Query Properties section, select **Find Related CIs** or **Find Unrelated CIs** to query for a pattern in which the two classes have or do not have relationships with each other, respectively.

  For example, **All Tomcat WAR CIs which are not connected to a Windows Server**.

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashed line</td>
<td>A relationship in a Service Mapping query.</td>
</tr>
</tbody>
</table>

- Add filters to a class node: Apply filters to narrow down a class to a specific set of CIs or to a single specific CI.
  a. Point to the node to add a filter to, and then click the **Apply filters** icon that pops up above the node.
  b. In the Filters section, add attribute and related list conditions.
  c. Close the **Filters** section.

  For example: Add a filter for business criticality to query for businesses that are 'most critical'.

  Click **Applied Filters** in the right-side bar to view all filters for each node on the canvas.
- Add And/Or operators to the query:
  a. Connect one node to two other nodes.
  b. Click the **And** box that appears on the connection line, to toggle between the **And** and the **Or** operators.

  For example C1 is Tomcat WAR, C2 is Linux Server, and C3 is Windows Server. Query for all Tomcat WAR CIs which are connected either to Linux Server Or to a Windows Server.
- Add property columns for a node, to display in the query results:

  **Note:** For a relationship, the query results display the **parent**, **child**, and **type** columns. You cannot add any other columns from the [cmdb_rel_ci] table.

  a. Click **Properties** in the right-side pane.
  b. Click a node once or twice, so that the node’s Report Columns section appears in the right-side bar, and then click **Add Columns**.
c. Select properties and then click outside the properties list to close it.

- Select columns and add filters that will be applied to the resulting set of services:
  a. Select Properties in the right-side bar, and then click an empty space on the canvas to ensure that nothing is selected.
  b. Click Add Columns at the bottom of the right-side bar and select columns to add. Click outside the columns list to close it.
  c. Click the Apply Service Mapping Query Filters icon at the top of the canvas and add filters.

- Inverse the entire query and search for all Service Mapping services that do not include the query pattern:
  - Click a node once or twice so that Query Properties appear in the right-side bar. In the Metadata section, toggle Services Including This Pattern to enable or disable the option.

- Add a search tag that can then be used as a search criteria for saved queries:
  a. Click the Add Tags icon at the top of the canvas.
  b. Click Add Tag and in the Query Tags dialog box enter one or more tag strings.
  c. Click the Add Tags icon again to close the Query Tags dialog box.

4. Click Save.

   On the Saved Queries tab, point to a saved query widget and click Query Information to view query details such as the query type, last update date, and the query schedules.

- Click Run.

   The query results pane displays only the first 100 results of the query.

   - Click Load More Results to display the next set of 100 results.
   - Click Load All Results to display the rest of the query results, up to the number specified by the glide.cmdb.query.max_results_limit system property (10,000 by default).

Click a CI to open its CI form, and on the CI form click Dashboard to view CI health in the CI dashboard.

**Note:** When a query is running, wait for it to complete or to time out before opening or running another query.

- Modify Query Builder settings: Click the (Settings) icon to open the Query Builder Settings dialog box.

- Copy and share the URL of a saved query with users that have access to the CMDB Query Builder. Pasting the shared URL in a new internet browser window, directly opens the saved query in the CMDB Query Builder.
- Create a report from CMDB query results.
- Create a schedule to run the query at a future time, and to email the results to interested parties.
• Export query results:
  Export query results that are visible: Click the Query Results context menu and select Export. Even if the Load More Results button is visible, indicating that there are additional query results, only the results that are visible are exported.
• Export and import a CMDB query to port a query definition between instances.
• Populate a CMDB group using the saved query.

Sample CMDB queries

Use the following sample queries to build your own CMDB queries.

Using the CMDB Query Builder requires that the UI16 plugin (com.glide.ui.ui16) is activated.

CMDB query sample

Use this example to build a CMDB query.

All servers with a connection to a database

1. Navigate to Configuration and click CMDB Query Builder
2. Click Create new. Enter a Name - All servers with a connection to a DB. Choose CMDB Query, and click Create.
3. In the CMDB Classes list, locate the Server class, and drag it to the canvas.
4. Locate the Database class, and place it to the right of the Server class node on the canvas.
5. Click at the center of the right side of Server, and then at the center of the left side of Database to create a connection.
6. Select the Server 1 node on the canvas. In the Relationship Types and Related Items section in the right-side bar, click Add Relationship Types and add all the relationships from the list.
   Note that the added relationships appear in the right-side bar, in the Relationship Types and Related Items section.
7. Click Save, and then click Saved Queries on the left to see the widget for the saved query.
8. Click the query widget to return to the canvas in edit mode.
9. Click Run to execute the query.
   Review the query results. Each row displays the name of a server CI, the name of a database CI, and the relationship type between them.
10. Add columns to the query results:
    a. Click the Server 1 node on the canvas once or twice so that the Server 1 Report Columns section appears in the right-side pane. Click Add Columns.
    b. Select Manufacturer and then click outside the columns list to close it.
    c. Click Run.
       Review the query results which now include the Manufacturer column.
    d. Click Save again to save all your customization for this query.

Service Mapping query sample

Use this example to build a Service Mapping query.
Linux server in services

**Note:** To build and run a Service Mapping query, Service Mapping must be activated.

1. Navigate to **Configuration** and click **CMDB Query Builder**
2. Click **Create new**. Enter a **Name** - *Linux server in services*. Choose **Service Mapping Query**, and click **Create**.
3. In the **CMDB Classes** hierarchy list, locate **Linux Server** and drag it to the canvas.
4. Click **Run**.
   Review the query results. Each row displays the name of a Service Mapping Service and the name of a Linux Server that is a member of that service.
5. On the right-side pane, click **Disable Service Including This Pattern** and then click **Run** again.
   Review the query results. Now, each row displays the name a Service Mapping Service that does not include the specified Linux Server.

Run a partial CMDB query

You can run a partial query in the CMDB Query Builder by defining a section of a query, and then running it.

The **UI16 plugin** (com.glide.ui.ui16) must be activated.

Role required: **cmdb_query_builder** (contained for itil, itil_admin, and asset)

While building a query or reviewing a saved query, you can run only a section of the query. On the canvas in the CMDB Query Builder, highlight a section of the query which contains the nodes and relationships of the partial query that you want to run. You can then examine the results of the partial query, and update the query if needed.

1. Navigate to **Configuration** and click **CMDB Query Builder**.
2. On the CMDB Query Builder page, click a tile to open an existing query.
3. Click the selection tool under the navigation tool to switch to a section selection mode.
4. Border a section of the query:
   a) Click the mouse device on the upper left corner of the section that you want to create.
   b) Drag the mouse device to the bottom right corner of the section that you want to create. As you drag the mouse device, the selected section is highlight in light blue.
   c) Release the mouse device. The query nodes that are included in the partial query, appear with a blue border.
5. Click **Run**.
6. In the **Pick Starting Node** dialog box, select the starting node for the partial query, and click **Confirm**.

The results of the partial query appear in the Results pane.

Navigation in CMDB Query Builder

Use the navigation tools to enlarge or shrink the query, to move the query, or to border a section of the query to run.

Using the Query Builder requires that the **UI16 plugin** (com.glide.ui.ui16) is activated.
Use the buttons in the navigation tool as follows:

- Use the plus sign (+) to increase magnification of the query.
- Use the minus sign (-) to decrease magnification of the query.
- Click the center dot to center the query on the canvas.
- Use the direction arrows to move the query in that direction.
- Use the selection tool under the navigation tool to toggle between two states:
  - Moving the entire query on the canvas.
  - Bordering a section of the query, which you can then run as a partial query.

Create a report from CMDB query results

After running a query in the CMDB Query Builder, you can generate static reports that are scoped to the query results.

The UI16 plugin (com.glide.ui.ui16) must be activated.

Role required:
- View report: cmdb_query_builder or cmdb_query_builder_read
- Create report: cmdb_query_builder or cmdb_query_builder_read, and report_user

In a base system, the cmdb_query_builder role is contained in the itil and asset roles.

1. Navigate to Configuration and click CMDB Query Builder.
2. Build a query.
3. In the query results pane, click the list context menu and select Bar Chart or Pie Chart.

The Reports application creates a report that is scoped to the query results.

Search saved queries

The CMDB Query Builder allows you to search for a specific saved query using any combination of search criteria based on the query's title, type, custom tags, and who created or updated the query.

To locate a saved query using a Query Tags search criteria, the query must have a query tag associated with it. For more information see Build a CMDB query using the CMDB Query Builder, or Build a Service Mapping query using the CMDB Query Builder.

The UI16 plugin (com.glide.ui.ui16) must be activated.

Role required: cmdb_query_builder (contained for itil, itil_admin, and asset)

1. Navigate to Configuration > CMDB Query Builder.
2. In the **Search Saved Queries** box on the **Saved Queries** tab, enter a string to search for.

   The resulting list displays all search categories that can be applied using the search string.

3. Select an item from the list to add it as a search criteria.

4. Refine the search string or select additional search criteria as needed.

### Create a schedule for a CMDB query

Schedule a saved CMDB query to run once at a scheduled time or on a recurring schedule, and to email the query results to specified users.

The **Ui16 plugin** (com.glide.ui.ui16) must be activated and a saved CMDB query that was built in the CMDB Query Builder must exist.

Role required: cmdb_query_builder (contained for itil and asset)

The query results are attached to the email as a file in the specified format. By default, the maximum result rows that can be attached is 10,000. This is controlled by a system property.

1. If need to, navigate to **Configuration**, click **CMDB Query Builder**, and then click a saved query.

2. Click **Create Schedule** and fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query</td>
<td>The query to run.</td>
</tr>
<tr>
<td>Users</td>
<td>Users who should receive query results email. To receive emails, users must have an Email address defined and have Notifications set to Enable in their user records.</td>
</tr>
<tr>
<td>Groups</td>
<td>Groups to email the query results to.</td>
</tr>
<tr>
<td>Zip output</td>
<td>Indicates whether the report should be sent as a zip file.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates whether to run the query according to the specified schedule.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency for running the query.</td>
</tr>
<tr>
<td>Time</td>
<td>Time of day to run the query.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Indicates whether to display the <strong>Condition</strong> field, which allows you to specify conditions under which the query runs.</td>
</tr>
<tr>
<td>Omit if not records</td>
<td>Indicate whether to distribute email if the query returns zero results.</td>
</tr>
<tr>
<td>Email addresses</td>
<td>Email addresses of users who should receive the email but who are not in the system.</td>
</tr>
<tr>
<td>Subject</td>
<td>Text that appears in the subject line of the distribution email.</td>
</tr>
<tr>
<td>Introductory message</td>
<td>Additional message that is delivered with the query results.</td>
</tr>
</tbody>
</table>
Export and import a CMDB query

Export a saved CMDB or Service Mapping query definition to an XML file which you can later import and run in the CMDB Query Builder. This process lets you port a saved query between instances, such as from a development environment to a production environment.

- You must save a query before you can export it.
- Domain in an exported query must be visible in both, source and destination instances.

Role required: cmdb_query_builder (contained in itil, itil_admin, and asset).

When exporting a combination query, the integrated Service Mapping query definition is included in the exported query.

For backward compatibility, you can alternatively Export and import a query as an update set.

1. Navigate to Configuration > CMDB Query Builder.
2. Export a saved query:
   a) In the Saved Queries tab, in either list view or card view, select a saved query.
   b) Click the Export query icon at the top of the Query Builder canvas.
   c) Wait for the Query Export Complete message to appear and then click Download.
      You can now access the query XML file.

3. Import a saved query:
   a) In the Saved Queries tab, click the Import query icon at the top of the CMDB Query Builder window.
   b) In Finder, select the saved query XML file and click Open.

      The imported query is available in the Saved Queries tab of the CMDB Query Builder on the instance.

Export and import a query as an update set

Export a saved query definition to an XML file as an update set, which you can later import.

Role required: To export — cmdb_query_builder (contained in itil and asset). To import — user with permission to import an update set.

Domain in the exported query must be visible in both, source and destination instances.

Export a query definition as an update set which you can later import and commit. This process lets you port a query between instances, such as from a development environment to a production environment.
For more information about exporting and then committing update sets using XML files, see Save an update set as a local XML file.

When exporting a combination query, the integrated Service Mapping query definition is included in the exported update set.

1. Export a saved query:
   a) In the Filter navigator, enter qb_saved_query.list and hit Enter to navigate to the Saved Queries table.
   b) In the Saved Queries list view, select the query that you want to export.
   c) Click Actions on selected rows and then select Export query.
   d) Wait for the Query Exporter to complete the export.

2. Import the exported saved query:
   a) Navigate to System Update Sets > Retrieved Update Sets.
   b) On the Retrieved Update Sets form, click Import Update Sets from XML.
   c) On the Import XML page, click Choose file and select the exported XML file. Then click Upload.
   d) Open the new record that was added to the Retrieved Update Sets list view.
   e) On the Retrieved Update Set form, click Preview Update Set Batch and then close the Batch Update Set Preview dialog box.
   f) Click Commit Update Set Batch and then close the Commit Update Set Batch dialog box.

The imported query is added to the Query Builder saved queries on the instance.

Settings for CMDB Query Builder

Use settings to control some aspects of the CMDB Query Builder behavior.

Using the Query Builder requires that the Ui16 plugin (com.glide.ui.ui16) is activated.

Open the Query Builder Settings dialog box:

1. Navigate to Configuration and click CMDB Query Builder.
2. On the CMDB Query Builder page, click the (Settings) icon.
3. Click the Settings icon again to close the dialog box.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Relationships in Results</td>
<td>Display the relationship between CIs in the query results.</td>
</tr>
</tbody>
</table>
Display Suggested Connections
Filter the CMDB classes and the non-CMDB tables lists in the left pane to display only classes and tables that the selected node on the canvas has a relationship with. You can then drag any item from the filtered list to the canvas, and connect it to the selected node on the canvas.
This setting applies only to CMDB queries.

Display Results in New Tab
Display query results in a separate browser tab titled Query Results.

Properties for CMDB Query Builder
Use the CMDB Query Builder properties to configure query processing.
These properties are available for CMDB Query Builder. To view and edit these properties, the admin role is required.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.cmdb.query.max_results_limit</td>
<td>Limits the number of results for a scheduled query and in the results section in the Query Builder when you click Load All Results.</td>
</tr>
<tr>
<td>glide.cmdb.query.batch_time_limit_in_sec</td>
<td>Time limit (in seconds) for running one batch to get one batch of query results (100 results).</td>
</tr>
<tr>
<td>glide.cmdb.query.query_time_limit_in_sec</td>
<td>Time limit (in seconds) for running an entire query to get all results.</td>
</tr>
<tr>
<td>glide.cmdb.query.non_cmdb.black_listed_tables</td>
<td>Blacklist of non-CMDB tables that appear in the CMDB Query Builder when creating a CMDB query.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
CMDB Search

Query on CMDB CIs and relationships by entering a search text with configurable synonyms and stop words, which CMDB Search converts into a properly formulated query.

CMDB Search is integrated into the global text search, providing enhanced capabilities for searching the CMDB. CMDB Search is designed to search within CMDB tables and relationships, allowing for queries that are more complex than basic text search. For example, you can query for all Tomcats that are running on Linux, or for all applications of a specific version that are running on Linux.

CMDB Search parses the search text that you enter, to formulate a properly formatted query that runs on the CMDB. Your search text can include plain words which are then parsed to identify any CMDB table, column, or relationship names. CMDB Search also uses synonyms and stop words to replace any plain text strings within your search text.

Localization is not supported for CMDB Search. In a localized instance, query words such as CI, relationship, or server, must be in English.

Stop Words

A collection of words that are ignored when CMDB Search parses your search text. When CMDB Search finds a stop word in your search text, that word is ignored. CMDB Search provides default stop words such as ‘if’, ‘me’, and ‘have’. You can delete or add stop words.

To view stop words, navigate to Configuration > CMDB Search > Stop Words.

Relation Synonyms

A collection of synonyms for relationships. CMDB Search searches your search text for strings that match any relationship synonym. For any such string that is found, CMDB Search replaces that string with the relationship type specified in the relation synonym. CMDB Search provides relationship synonyms for common words that stand for any relationship between two tables. For example, the strings “connect”, “in”, and “on” in your search text, are all treated as a general reference to a relationship, without specifying any relationship in particular. You can modify, delete, or add relationship synonyms.

To view relationship synonyms, navigate to Configuration > CMDB Search > Relation Synonyms.

CI Class Synonyms

A collection of synonyms for CI classes. CMDB Search searches your search text for strings that match any CI class synonym. For any such string that is found, CMDB Search replaces that string with the CI class name specified in the CI class synonym. CMDB Search provides at least one default CI class synonym for each CMDB table. Most default CI class synonyms are the class label. You can modify, delete, or add CI class synonyms.

To view CI class synonyms, navigate to Configuration > CMDB Search > CI Class Synonyms.

Column Synonyms

A collection of synonyms for table columns. CMDB Search searches your search text for strings that match any column synonym. For any such string that is found, CMDB Search replaces that string with the column name specified in the column synonym. CMDB Search provides at least one default column synonym for each table column in the CMDB. Most default column synonyms are similar to the column name itself. You can modify, delete, or add column synonyms.

To view column synonyms, navigate to Configuration > CMDB Search > Column Synonyms.

CMDB Search supports domain separation, searching CIs according to the user domain.
Plugin

To use CMDB Search, activate the CMDB Search (com.snc.cmdb_search) plugin. Activating CMDB Search, triggers an indexing of all CMDB tables to enable using Zing, which is required for some CMDB Searches.

Search text format and examples

The format of the search text is:

\[(<CI \text{ class name}> (<attribute> "value")* (<relationship>)* )*\]

Consisting of a table name, followed by pairs of \(<column> "<value>"\), without any separating commas, and with values surrounded by quotation marks. For column, table, and relationship names, you can search by actual names, labels, or synonyms, and column names can be omitted.

Examples:

- application runs on ci name "ciname"
- application name "JBoss Server13" version "1.0.0.0" on tomcat name "Tomcat10" version "2.1"
- tomcat on linux
- tomcat name "My Tomcat" version "2.0" running on linux server name "Linux8"
- tomcat "My Tomcat"
- tomcat name "My Tomcat"
- tomcat name related to Linux server "my server"
- tomcat name related to Linux server ip 1.1.1.1
- services related to tomcat "my tomcat"
- CI impacted by service "EmailService"

Sometimes the search text contains a name, such as Port, which is both a class and a column name. In this situation, the CMDB Search strategy is to first search for a class with the specified name, and then search for a column with the specified name. If this strategy does not yield the expected results, then use the actual class or column name to prevent ambiguity.

Results

Up to 10 query results appear after running the query. To view any additional results, click View all <record> matches. The total number of results that you can view depends on the value of the cmdb.search.rows.limit system property, which is set to 100 by default. You can increase this property value, or you can change the query to return a smaller number of results. Increasing the number of query results might impact performance.

Add synonyms and stop words to CMDB Search

Create, delete, or modify CI class synonyms, column synonyms, relationship types synonyms, and stop words for CMDB Search.

The CMDB Search (com.snc.cmdb_search) plugin must be activated.

Role required: cmdb_read

You can add any number of synonyms or stop words. There can be multiple synonyms for the same CI class, column, or relationship type.
• Add a CI class synonym:
  a) Navigate to Configuration > CMDB Search > CI Class Synonyms.
  b) Click New and fill out the CMDB Search CI class synonym form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Designates that the synonym is in effect.</td>
</tr>
<tr>
<td>Synonym</td>
<td>String to replace with CI type when parsing the search text.</td>
</tr>
<tr>
<td>CI class</td>
<td>The CMDB class for which the synonym applies.</td>
</tr>
<tr>
<td>Is attribute value</td>
<td>Designates that the synonym is applied only for CIs with an attribute whose value equals the synonym. When checked, the synonym is searched through the columns of the CI class. For example, 'Ubuntu' is specified as a synonym for the cmdb_ci_linux_server CI class, but only if one of the CI's attributes (such as operating system) is 'Ubuntu'.</td>
</tr>
</tbody>
</table>

c) Click Submit.

• Add a column synonym:
  a) Navigate to Configuration > CMDB Search > Column Synonyms.
  b) Click New and fill out the CMDB Search column synonyms form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Designates that the synonym is in effect.</td>
</tr>
<tr>
<td>Column</td>
<td>The CMDB column for which the synonym applies.</td>
</tr>
<tr>
<td>Synonym</td>
<td>String to replace with Column when parsing the search text.</td>
</tr>
</tbody>
</table>

c) Click Submit.

• Add a relationship type synonym:
  a) Navigate to Configuration > CMDB Search > Relation Synonyms.
  b) Click New and fill out the CMDB Search relation synonym form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Designates that the synonym is in effect.</td>
</tr>
<tr>
<td>Synonym</td>
<td>String that represents any relationship type.</td>
</tr>
</tbody>
</table>
• Add a stop word:
  a) Navigate to Configuration > CMDB Search > Stop Words.
  b) Click New and fill out the Stop Words form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Designates that the synonym is in effect.</td>
</tr>
<tr>
<td>Stop word</td>
<td>String to ignore when parsing the search text.</td>
</tr>
</tbody>
</table>

c) Click Submit.

When parsing a search text in the global text search box, CMDB Search uses all synonyms and stop words.

Components installed with CMDB search

Several types of components are installed with activation of the CMDB Search (com.snc.cmdb_search) plugin, including tables and properties.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronize CMDB Search synonyms for new CIs and Columns</td>
<td>Synchronizes new CI types and new columns to synonym tables. Runs once a day.</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI synonyms [search_cmdb_ci_synonym]</td>
<td>CI class synonyms used by CMDB search when parsing search text.</td>
</tr>
<tr>
<td>Column synonyms [search_cmdb_column_synonym]</td>
<td>Column synonyms used by CMDB search when parsing search text.</td>
</tr>
<tr>
<td>CMDB Search classifier synonyms [search_cmdb_classifier_synonym]</td>
<td>Relationship types synonyms used by CMDB search when parsing search text.</td>
</tr>
</tbody>
</table>

Properties installed

Note: To open the System Property [sys_properties] table, enter sys_properties.list in the navigation filter.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmdb.search.raws.limit</td>
<td>Maximum number of records to include in the query results.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 100</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> System Properties [sys_properties] table.</td>
</tr>
<tr>
<td>cmdb.search.timeout.sec</td>
<td>Number of seconds to wait before timing out the query.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 45</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> System Properties [sys_properties] table.</td>
</tr>
</tbody>
</table>

**CMDB CI Lifecycle Management**

From the time of its creation to the time that it is no longer needed, a CMDB CI would typically transition through several operational states while undergoing various operations. CI Lifecycle Management provides the mechanism to define states and actions for a CI and lets you apply appropriate actions based on a CI’s state to tailor the management of CI lifecycle to business needs.

Terms associated with CI Lifecycle Management:

**Operational states**

A set of states that a CI can be at such as 'Operational' or 'Repair in Progress'. A CI can be associated with only a single operational state at any given time. The choices for operational states are based on the **operational_status** field in the [cmdb_ci] table. There are several operational states that are defined in the base system such as 'Retired' and 'Repair in Progress'. You can modify this list to reflect operational states that are relevant in your business.

**Note:** By default, Service Mapping is configured to ignore all host CIs for which the value of Operational status [operational_status] is not 1 (Operational) or the value of status [install_status] is 100 (absent). For additional information about this behavior, see Preparing customized ServiceNow deployments to work with Service Mapping [KB0647574] in the HI Knowledge Base.

CI Lifecycle Management allows multiple operators and automations to simultaneously set different operational states of a CI. Since a CI cannot be associated with multiple operational states, it is important to configure each operational state with a priority. These priorities are then used in such situation to determine which of the operational states is the cumulative operational state.

**CI actions**

A set of actions that can be applied to a CI during its lifetime. You can define CI actions that are relevant in your business.

**Compatible CI Actions**

CI Lifecycle Management allows a CI to have multiple active CI actions simultaneously, however they must be specifically defined as compatible. By default, there are no two actions for a CI that are compatible with each other. You can change this behavior by specifying pairs of actions that are compatible and thus allowed to be applied simultaneously to a CI. For example, you can specify...
that the ‘Patching’ and the ‘Provisioning’ CI actions are compatible making it possible to apply both simultaneously to a CI.

**Not Allowed CI Actions**

By default, any CI action can be applied to any CI. You can restrict this behavior by defining a rule that an action is not allowed for a CI when it is in a specific operational state. For example, you can define a Not Allowed CI Action in which it is not allowed to apply the ‘Provisioning’ action to a Linux Server that is in a ‘Non-Operational’ state.

**Not Allowed Operational Transitions**

By default, transitions are allowed from any operational state to another. You can restrict this behavior by defining a rule that for a specified CI, a transition from a certain operational state to another operational state is not allowed. For example, you can define that for a Linux Server it is not allowed to transition from 'Repair in progress' to 'Non-Operational'.

**Requestor**

A requestor can be a workflow or a non-workflow operator that is trying to set operational states and apply CI actions. Each requestor has an associated requestor ID that is a GUID and that can be an active workflow context or a non-workflow registered operator ID.

**Lease time**

A time period that each requestor (especially non-workflow operators) can provide, during which a specified CI action is allowed to be active for a specified CI.

CMDB CI Lifecycle Management provides a set of APIs to manage CI operational states and CI actions. And the UI where you define a set of rules to restrict certain operational state transitions and to restrict actions based on operational states. It also provides a mechanism to audit CI operational state and CI actions during the entire CI lifecycle.

Providers such as automation, workflows, or Change Management can use CI Lifecycle Management as a mechanism to manage CI operational states and apply CI actions. By default, the behavior of CI Lifecycle Management has no restrictions on some operations, and full restrictions on other operations. The CI Lifecycle Management UI lets you modify this default behavior by specifying Not Allowed CI Actions, Compatible CI Actions, and Not Allowed Operational Transitions that restricts some operations and enables for others.

With CI Lifecycle Management you can:

- Manage CI operational states and CI actions throughout the entire CI lifecycle.
- Manage CI operational state transitions.
- Restrict certain operational state transitions.
- Associate certain actions for certain CI types that are in specific operational state.
- Restrict IT Service Management applications based on CI operational state.
- Audit CI operational states and CI actions during the entire CI lifecycle.

**Lifecycle management APIs**

CI Lifecycle Management provides a set of APIs to manage CI operational state and CI actions during the entire CI lifecycle. All restrictions and allowances specified by rules in the UI are enforced when state management APIs run, and if an API attempts to perform a restricted operation, the operation is blocked and an error is logged.
Registering requestors

When using the lifecycle management APIs to apply CI actions, requestors are required to be registered and to obtain a requestor ID which is unique within the lifecycle management tables. To register and to obtain a requestor ID, non-workflow users should call the registerOperator API. Workflow users can use the active Workflow context as the requestor ID, and they do not need to explicitly call registerOperator.

After completing the CI lifecycle operations, the requestor should call the unregisterOperator API to unregister. All the state management records associated with that specific requestor ID are then marked as inactive or they are removed by the CI Lifecycle Management — Restore Internal State Management Tables scheduled job.

Integration with Incident Management and Problem Management

A base instance includes the pre-defined CI action CreateTask used for creating a task for a CI. New instances have a pre-defined Not Allowed CI Action, specifying that the CreateTask action is not allowed for any CI with a Retired operational state. This restriction is integrated with Incident Management and with Problem Management to prevent the creation of incident or problem tasks for retired CIs. The CreateTask CI action is used as a reference qualifier to the Configuration Item field of the Incident/Problem tables. In a new incident or problem, CIs in which Operational Status is Retired — are filtered out from the Configuration Item list on the form. For more information about reference qualifiers, see Reference qualifiers.

Integration with Asset Management

In a base system, a CI’s Operational Status field and the Status/Hardware Status (if its hardware) fields are kept synchronized if one of the two fields’ values is Retired. When Operational Status of a CI is set to Retired, then the Status/Hardware Status field is automatically set to Retired. In the opposite direction, when the Status/Hardware Status field of a CI is set to Retired, Operational Status is then automatically set to Retired too. When an Operational Status field changes from Retired to another status, the CI’s Status/Hardware Status field is set to Installed. And when a CI’s Status/Hardware Status field changes from Retired to another status, the Operational Status field is automatically set to Non-Operational.

Whenever CI’s Status/Hardware Status changes, it is synchronized to the CI’s corresponding Asset State field, and vice versa — keeping the CI’s Operational Status and the CI’s corresponding Asset State synchronized.

For more information about mapping Asset State and Substate fields to a CI’s Status/Hardware Status (if its hardware) field, see Map asset state and CI hardware status. And for more information about retiring assets, see Retire assets.

Get started with CI Lifecycle Management

Follow these high level steps to get started and to track activities of the CI Lifecycle Management module of the CMDB application.

1. Activate the base system CI Lifecycle Management - Restore Internal State Management Tables scheduled job that continuously checks and maintains data integrity of all internal CI Lifecycle Management tables.
2. Define CI actions.
3. Define compatible CI actions rules.
   Navigate to Configuration > CI Lifecycle Management > CMDB CI Actions to display currently active/inactive CI actions in the CMDB.
4. Define not-allowed CI actions rules.
5. Define not-allowed operational state transitions rules.
6. Define new operational states by modifying the operational_status field in the [cmdb_ci] table in the system dictionary.
   Navigate to Configuration > CI Lifecycle Management > View Internal Operational States to display available operational states set by each requestor.
7. Set priority for operational states.
8. Call APIs to apply CI actions.
   Navigate to Configuration > CI Lifecycle Management > CMDB CI Actions to display which actions were submitted and their active/inactive state in the CMDB.
9. Navigate to Configuration > CI Lifecycle Management > View CI State Registered Users to display currently registered operators that were registered via the registerOperator API.
10. Review Renew Lease tasks and extend leases as needed: Navigate to Configuration > CI Lifecycle Management > Renew Lease Tasks. These tasks are created automatically by the CI Lifecycle Management - Restore Internal State Management Tables scheduled job for CI action records in which the lease for a valid requester has expired. The Requestor should use the lifecycle management API ExtendCIActionLease to extend the lease. Otherwise, if the lease remains expired for a specified grace period, the CI Lifecycle Management - Restore Internal State ManagementTables scheduled job marks the respective CI action record as 'inactive'.
    The grace period for expired lease time is configurable by the system property glide.cmdb.statemgmt.max_lease_expired_days.
11. Navigate to Configuration > CI Lifecycle Management > State Management Logs to display logs of CI Lifecycle Management operations.

Lifecycle management APIs

CI Lifecycle Management provides a set of state management APIs for manipulating CI operational states, and applying CI actions. State management APIs adhere to restrictions and allowances specified by Not Allowed CI Actions, Compatible CI Actions, and Not Allowed Operational Transitions. If an API attempts to perform a restricted operation, the operation is blocked, an error is logged, and a task is automatically created if appropriate.

Lifecycle management APIs can set operational states and CI actions to CMDB groups by utilizing lifecycle management bulk APIs.

Registration APIs

- registerOperator() - Method to register operator with state management for non-workflow user.
- unregisterOperator(String requestorId) - Method to unregister operator for non-workflow users.
- isValidRequestor(String requestorId) - Method to determine if the specified requestor is a valid active workflow user or a registered user.
- isLeaseExpired(String requestorId, String ciSysId, String ciActionName) - Method to check if registered user lease expired.
- extendCIActionLease(String requestorId, String ciSysId, String ciActionName, String leaseTime) - Method to extend CI Action Lease time, for registered users. If previous lease already expired, extend lease from now.

Operational State APIs

- setBulkCIOperationalState(String requestorId, String sysIdList, String opsLabel, String opsStateListOld) - Method to set Operational State for an array of CIs.
• `getOperationalState(String ciSysId)` - Method to get CI Operational State.

**CI Actions APIs**

• `addBulkCIAction(String requestorId, String sysIdList, String ciActionName, String ciActionListOld, String leaseTime)` - Method to add CI Action for an array of CIs.
• `removeBulkCIAction(String requestorId, String sysIdList, String ciActionName)` - Method to remove a CI Action for a list of CIs.
• `getCIActions(String ciSysId)` - Method to get CI Actions.

**Not Allowed Action Based on Operational State API**

• `isNotAllowedAction(String ciType, String opsLabel, String actionName)` - Method to check if a specific CI action is not allowed for specific Operational State on a CI Type.

**Not Allowed Operational State Transition API**

• `isNotAllowedOpsTransition(String ciType, String opsLabel, String transitionOpsLabel)` - Method to check if specific operational state transition is not allowed on a CI Type.

**Compatible Action API**

• `isCompatibleCIAction(String actionName, String otherActionName)` - Method to check if two specific actions are compatible with each other.

**Using state management APIs**

```javascript
// 1. Register Operator with State Mgmt
var output = SNC.StateManagementScriptableApi.registerOperator();
var jsonUntil = new JSON();
var result = jsonUntil.decode(output);
var requestorId = result.requestorId;

// Get list of sys_ids to update
var sys_ids;

// 2. Set list of sys_ids's Operational State to 'Repair in Progress'
output = SNC.StateManagementScriptableApi.setBulkCIOperationalState(requestorId, sys_ids, 'Repair in Progress');
gs.print(output);

// 3. Set list of sys_ids's CI Action State to 'Patching'
output = SNC.StateManagementScriptableApi.addBulkCIAction(requestorId, sys_ids, 'Patching');
gs.print(output);
```
Components installed by CI Lifecycle Management

Several types of components are installed by CI Lifecycle Management (included in the com.snc.cmdb plugin), including tables, scheduled jobs, and properties.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Lifecycle Management - Restore Internal State Management Tables</td>
<td>Continuously checks and maintains the data integrity of all internal CI Lifecycle Management tables.</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI State Registered Users [statemgmt_register_users]</td>
<td>All currently active registered users that were created via the registerOperator API. You cannot manually add new records to this table.</td>
</tr>
<tr>
<td>CI Actions [statemgmt_ci_actions]</td>
<td>A set of CI actions that can be applied to a CI during its lifetime.</td>
</tr>
<tr>
<td>CMDB CI Actions [statemgmt_cmdb_actions]</td>
<td>Active/inactive CI actions set by a specific requestor for a specific CI. You cannot manually add new records to this table.</td>
</tr>
<tr>
<td>Compatible CI Actions [statemgmt_compat_actions]</td>
<td>Set of rules that define pairs of CI actions that are compatible for a CI and can be applied simultaneously.</td>
</tr>
<tr>
<td>Not Allowed CI Actions [statemgmt_not_allow_actions]</td>
<td>Set of rules that define specific actions that are not allowed for a CI when its in a specific operational state.</td>
</tr>
<tr>
<td>Internal Operational States [statemgmt_ops_state]</td>
<td>Internal operational states set by a specific active requestor for a specific CI. You cannot manually add new records to this table.</td>
</tr>
<tr>
<td>Renew Lease Task [statemgmt_renew_lease_task]</td>
<td>Set of tasks that were automatically created to renew the lease of CI actions whose lease has expired. You cannot manually add new records to this table.</td>
</tr>
<tr>
<td>Operational State Priorities [statemgmt_ops_state_pri]</td>
<td>Priorities of operational states which determine precedence when multiple operational states are set for same CIs by different requestors.</td>
</tr>
<tr>
<td>Not Allowed Operational Transitions [statemgmt_not_allow_ops]</td>
<td>Set of rules that define specific operational state transitions that are not allowed.</td>
</tr>
</tbody>
</table>
Properties installed

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.cmdb.statemgmt.max_lease_expired_days</td>
<td>Maximum number of days that lease expiration can be set with for CI Actions.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 15</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table.</td>
</tr>
<tr>
<td>glide.cmdb.statemgmt.max_bulk_count</td>
<td>Maximum number of CIs that CI Lifecycle Management can process in a bulk update operation.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1000</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table.</td>
</tr>
</tbody>
</table>

Activate the CI Lifecycle Management scheduled job

When starting to use the CI Lifecycle Management module, ensure to activate the **CI Lifecycle Management - Restore Internal State Management Tables** scheduled job which is disabled by default. This scheduled job continuously checks and maintains the data integrity of all internal CI Lifecycle Management tables.

When CI Lifecycle Management operations do not complete properly, for example due to a failure of the requestor or a requestor whose lease has expired, the integrity of tables related to CI Lifecycle Management might be compromised. The **CI Lifecycle Management - Restore Internal State Management Tables** scheduled job scans tables related to CI Lifecycle Management, and does the following:

- De-activates or removes all internal lifecycle management records with invalid requestors, and closes any corresponding Renew Lease Tasks if present.
- Detects records associated with a valid requestor whose lease has expired, and automatically creates a Renew Lease Task to notify the user and to provide details for extending the lease. If the requestor takes no action and the lease remains expired for a specified grace period (default 15 days), automatically de-activates the corresponding CI action record, and closes any corresponding Renew Lease Task if present.

1. Navigate to **System Definition**, and click **Scheduled Jobs**.
2. Search for the **CI Lifecycle Management - Restore Internal State Management Tables** job.
3. In the respective **Active** column, double-click the value **false**, and select **true**.
4. Click the **Save** icon.

Define a CI action

Define a CI Lifecycle Management CI action that can be later applied to CIs.

You can view a list of all the actions that are currently applied to CIs by navigating to **Configuration** and clicking **CMDB CI Actions**.

1. Navigate to **Configuration > CI Lifecycle Management > CI Actions**.
2. On the **CI Actions** page, click **New**. Fill in **Name** and **Description**, and then click **Submit**.
Define compatible CI actions

Allow a CMDB CI Lifecycle Management operation in which two specified CI actions can be applied simultaneously to a CI.

By default, it is not allowed to apply more than a single action to a CI. You can change that behavior by defining pairs of CI actions as compatible and therefore these actions can be applied simultaneously to a CI. For example you can specify that Provisioning and Patching are compatible CI actions, which lets you apply both to a CI at the same time.

1. Navigate to Configuration, and click Compatible CI Actions.
2. On the Compatible CI Actions page click New and fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>First action in the compatibility actions pair.</td>
</tr>
<tr>
<td>Compatible Action</td>
<td>Second action in the compatibility actions pair.</td>
</tr>
</tbody>
</table>

An API can successfully apply the two specified actions simultaneously to a CI.

Define a not-allowed CI action

Define a restriction for CI Lifecycle Management in which a specified action is not allowed for a CI that is in a specified operational state.

By default, there are no restrictions in the CMDB CI Lifecycle Management on applying CI actions. You can restrict this behavior by not allowing a specified action to be applied to a CI when it is in a specified operational state. For example, you can define a restriction in which the provisioning action cannot be applied to a Linux Server that is in a non-operational state.

1. Navigate to Configuration > CI Lifecycle Management > Not Allowed CI Actions.
2. Click New on the Not Allowed CI Actions page, and fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Allowed Action</td>
<td>The action that is being restricted.</td>
</tr>
<tr>
<td>CI Type</td>
<td>The CI type for which the restriction applies to.</td>
</tr>
<tr>
<td></td>
<td>To apply a rule to all CIs, select Configuration Item.</td>
</tr>
<tr>
<td>Operational State</td>
<td>The operational state that the CI must be at in order to apply the restriction.</td>
</tr>
</tbody>
</table>

3. Click Submit.

If an API attempts to apply the specified action to the specified CIs, while it is in the specified operational state, the operation fails and an error is logged.

Set priority for an operational state

CI Lifecycle Management allows multiple operators or automations to simultaneously set different operational states for a CI. A CI can have only a single operational state, so in this case, the cumulative operational state of the CI is set to the one with the highest priority. It is recommended that you specify a priority for each operational state that you define so that a cumulative state can be correctly calculated.
1. Navigate to **Configuration > CI Lifecycle Management > Operational State Priority**.

2. On the **Operational State Priority** page, click the operational state for which you want to set or update priority.

3. Enter a **Priority** and click **Update**.
   
   Smaller numbers represent higher priority.

**Define a non-allowed operational transition**

Define a restriction for CI Lifecycle Management in which a specified CI cannot transition from one operational state to another.

By default, CI Lifecycle Management has no restrictions for transitioning CIs from one operational state to another. You can restrict this behavior by defining transitions that are not allowed for a specified CI. For example, you can define a restriction on transitioning a Linux server from non-operational state to repair in progress state.

1. Navigate to **Configuration > CI Lifecycle Management > Not Allowed Operational Transitions**.

2. On the **Not Allowed Operational Transitions** page, click **New** and fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Type</td>
<td>The CI type for which the restriction applies.</td>
</tr>
<tr>
<td>Not Allowed Transition</td>
<td>The CI state into which transitioning is restricted.</td>
</tr>
<tr>
<td>Operational State</td>
<td>The operational state that the CI must be in for the restriction to apply.</td>
</tr>
</tbody>
</table>

If an API attempts to transition a CI that is in the specified operational state to a state that is not allowed, the operation fails and an error is logged.

**CMDB groups**

A CMDB group is a collection of CIs that lets you apply CI actions collectively to all the CIs that are members in the group. For example, a CMDB CI Lifecycle Management API can use a CMDB group scriptable API to retrieve the group's list of CIs, and then apply a CI Lifecycle Management action collectively to all the CIs.

**Group type**

A CMDB group is configured with a group type. If a CMDB group is set with the Health group type, then the CIs in the group can be monitored by CMDB Health, and the aggregated health is reported for the group as a whole in the CMDB group view dashboard. For example, you can monitor health only for CIs in a specific location.

**Populate a CMDB group**

Depending on the group type, you can populate a CMDB group by manually adding individual CIs, selecting saved CMDB queries, or building encoded queries in the CMDB group itself. The resulting CIs from each query are added as members to the group.

Roles required:

- To view CMDB groups - itil
- To use a CMDB queries - cmdb_query_builder on top of itil

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• To manually add CIs - itil or asset

Also, to populate a CMDB group using a CMDB query, a saved CMDB query must exist.

1. Navigate to Configuration > CMDB Group.
2. In the CMDB Groups pane click New.
3. Fill out the form, right-click the title bar and select Save.

<table>
<thead>
<tr>
<th>CMDB Group form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Group Name</td>
</tr>
</tbody>
</table>
| Group type    | • Default: Basic group type which can be populated by manually adding CIs, saved queries, and encoded queries.  
• Health: Sets CMDB Health to monitor the health of the group CIs and aggregate health results for the group as a whole. Can be populated only by encoded queries. |

Note: Dynamic filters are not supported when populating this type of CMDB groups.

4. To use saved CMDB queries:
   a) Click CMDB Group Contains Saved Queries and then click Add Query.
   b) Select a query from the Query Builder Saved Query list.
   c) Click Submit.

   The query that is used returns a list of CIs of the class in the start node of the query.

5. To manually add CIs:
   a) Click CMDB Group Contains Configuration Items and then click Edit Manual CI.
   b) Optionally add filters.
   c) Select CIs in the Configuration Item list and click the '+' icon at the bottom.
   d) In the Group members list, select the CIs to add to the group.
   e) Click Save or Save and Exit.
   f) In the Save Confirmation dialog box, click OK.
   g) Click Submit.
To use encoded queries:

a) Click **CMDB Group Contains Encoded Queries** and then click **New**.

b) Select a class for which the encoded query applies to and add conditions to build a query. The resulting CIs are included in the group.

![Note: Dynamic filters are not supported for CMDB health-type groups, even though it is possible to add them in a condition clause.]


c) Click **Submit**.

Click **Show All CI** to display all CI members of the group.

### Show CI Lifecycle Management details for CMDB group CIs

Display CI Lifecycle Management operational state and CI actions that apply to the CIs that are members of a CMDB group.

If the CMDB group is based on a CMDB query, then the query runs in real-time and displays the resulting CIs. If the query does not complete successfully due to timing out or for other reasons, then appropriate error messages are displayed.

1. Navigate to **Configuration > CMDB Groups**.
2. On the **CMDB Groups** page, click on a CMDB group.
3. Click **Show All CI**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item</td>
<td>CI group member.</td>
</tr>
<tr>
<td>Class</td>
<td>Class of CI group member.</td>
</tr>
<tr>
<td>Operational Status</td>
<td>CI Lifecycle Management operational state of the CI such as 'Repair in Progress' or 'Operational'. Possible operational states are defined in the choice list of the <strong>Operational status</strong> field in the <em>cmdb_ci</em> table.</td>
</tr>
<tr>
<td>Actions</td>
<td>CI Lifecycle Management actions that apply to the CI such as 'Cloning' and 'Provision'. Possible actions are defined in the CMDB CI Actions [statemgmt_cmdb_actions] table.</td>
</tr>
</tbody>
</table>

### CMDB Identification and Reconciliation

The Identification and Reconciliation module provides a centralized framework for identifying and reconciling data from different data sources. It helps maintain the integrity of the CMDB when multiple data sources such as EventManagement, Discovery, ImportSets, and ManualEntry are used to create and update CI records.

The use of multiple sources increases the risk of introducing inconsistencies through duplicate records. To maintain the integrity of the database, it is important to correctly identify CIs and services so that new records are created only for CIs that are truly new to the CMDB. Identification and Reconciliation helps you prevent duplication of CI records, reconcile CI attributes, reclassify CIs, and allow only authoritative data sources to update the CMDB.
Domain separation in CMDB Identification and Reconciliation

This is an overview of domain separation and the CMDB Identification and Reconciliation feature. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

This topic explains how domain separation is enforced during the CMDB Identification and Reconciliation process. In addition this topic addresses how domain separation is applied to the Identification and Reconciliation rules.

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

How domain separation works in Identification and Reconciliation

The identification process is domain aware. If the domain separation plugin has been activated, then identification processes only those CIs in which the domain ID is identical to the domain of the currently logged on user. If duplicate CIs exist across domains (including parent and child domains), then those CIs are not considered duplicate CIs because their domain IDs do not match. Domain separation in the identification engine is enforced as soon as users activate the domain separation plugin.

Domain separation during the Identification and Reconciliation Process

- Domain separation during the Identification/Reconciliation process is enforced through the domain ID.
  - Domain IDs do not need to be explicitly sent in the input payload of the identification engine APIs. Internally, the identification engine causes the current domain ID of the user to call the identification engine APIs.
  - Only CIs that have the same domain ID as the currently logged-in user's domain display during matching.
  - During matching, if no records are found and a CI needs to be inserted, the CI's domain ID is the same as the domain ID of the currently logged-in user’s domain.
  - During matching, if duplicates are found, De-Duplication tasks created in the [reconcile_duplicate_task] table, have the same domain ID as those of the duplicate CIs.
  - Duplicate CIs that exist across domains (including parent and child domains) are not considered as duplicate CIs by the identification engine.
  - During matching, if reclassification of the CI is not allowed, reclassification tasks are created in the [reclassification_task] table, with the same domain ID as the CI for which reclassification is needed.

Domain separation and Identification Rules

- The identification rules and identification inclusion rules used during the identification process are always defined at the global level. For example, the tables below do not have a sys_domain field:
  - Identifier (cmdb_identifier), Identifier Entries (cmdb_identifier_entry), Related Entries (cmdb_related_entry), and Identification Inclusion Rules (cmdb_ie_active_config).
Domain separation and Reconciliation Rules

- The reconciliation definition rules and data source precedence rules that are used during the reconciliation process can be defined for different domains. For example, the tables below do have sys_domain, sys_overrides, sys_domain_path fields:
  - Reconciliation Definition (cmdb_reconciliation_definition), Datasource Precedence (cmdb_datasource_precedence), and Data Source Staleness Definitions (cmdb_datasource_staleness).

Identification and reconciliation components and process

The CMDB identification and reconciliation functionality is supported by identification rules, reconciliation rules, de-duplication tasks, and reclassification tasks.

Components of Identification and Reconciliation

Identification

Identification is the process of uniquely identifying CIs, to determine if the CI already exists in the CMDB or if it is a newly discovered CI that must be added to the CMDB. The identification engine performs identification processes, relying on identification rules.

Reconciliation

Reconciliation is the process of reconciling CIs and CI attributes by allowing only designated authoritative data sources to write to the CMDB at the CI table and attribute level. The CMDB is updated in real time as records are being processed. There is no staging area to verify the reconciliation activities before they are committed. The process relies on reconciliation rules.

De-duplication tasks

If the instance encounters duplicate CIs during the identification and reconciliation process, it groups each set of duplicate CIs into a de-duplication task. Review the information in these tasks to see how it was determined that these CIs are duplicates.

Reclassification tasks

During the CI identification process, a matched CI might need to be upgraded, downgraded, or switched to another CI class. If automatic reclassification is disabled, then the system generates a reclassification task. Review the information in these tasks, and decide whether a manual reclassification of the CI is appropriate.

APIs

The Identification and Reconciliation APIs are a centralized set of APIs that can be used with different sources of data such as Discovery, Monitoring, or Import Sets. You can use it to enforce identification and reconciliation before data is stored in the CMDB. Data sources do not directly write to the CMDB. Instead, they call the APIs first to ensure that the data being written does not introduce inconsistencies.

Identification engine APIs are accessible in scoped apps. See Activate Configuration Management For Scoped Apps (CMDB) for information about how to activate the plugin, and how to script a scoped app to access those APIs.

- createOrUpdateCI(): A scriptable API that creates or updates a CI based on identification and reconciliation rules.
- **identifyCI()**: Similar to the **createOrUpdateCI** API, but does not commit the result to the database. Use this API with a given payload to find out if the identification engine will perform insert or update operations, without committing the operation.
- **CMDBTransformUtil**: An API to be used exclusively with Import Sets to **apply identification and reconciliation processes to data imported by Import Sets**.

Predefined identification and reconciliation rules are included for tables that are in the base instance. You can customize these rules for your organization. When a new table is created in the CMDB, it derives identification and reconciliation rules from its parent table if these rules exist. To apply identification and reconciliation rules to a new table, create the rules either at the child level or at its parent level.

**Process flow of Identification and Reconciliation**

![Flowchart of Identification and Reconciliation](chart.png)

**Identification and Reconciliation Engine (IRE)**

IRE is an underlying key component in Identification and Reconciliation, providing a centralized framework to perform identification and reconciliation processes across different data sources. IRE uses identification
rules and reconciliation rules when processing incoming data before inserting that data to the CMDB. IRE processes help maintain data integrity in the CMDB.

- IRE prevents duplicate CIs by uniquely identifying CIs.
- IRE reconciles CI attributes by allowing only authoritative data sources to write to CMDB.

**Activate Configuration Management For Scoped Apps (CMDB)**

You can activate the Configuration Management For Scoped Apps (CMDB) plugin (com.snc.cmdb.scoped) to allow a scoped app in scripts to use the prefix 'sn_cmdb.IdentificationEngine.<method>' to access identification engine APIs. This plugin does not include demo data and activates related plugins if they are not already active.

Role required: admin

For plugin activation steps, see Activate a plugin.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Apply CI Identification and Reconciliation to Import Sets**

You can apply CMDB Identification and Reconciliation processes when Import Sets are used to import CIs into the CMDB. CI identification can prevent duplicate CIs in the CMDB, which Import Sets might otherwise cause.

Populating CMDB tables using Import Sets can inadvertently result in duplicate CIs when multiple imported records are identical to an existing CI. To minimize this duplication, you can apply CMDB Identification and Reconciliation processes to Import Sets when importing new records into CMDB tables.

**Transform map script**

In the onBefore transform map script for an import set, add a call to the CMDBTransformUtil API, similar to the following code sample:

```javascript
(function runTransformScript(source, map, log, target) {
    // Call CMDB API to do Identification and Reconciliation of current row
    var cmdbUtil = new CMDBTransformUtil();
    cmdbUtil.identifyAndReconcile(source, map, log);
    ignore = true;

    if (cmdbUtil.hasError()) {
        var errorMessage = cmdbUtil.getError();
        log.error(errorMessage);
    } else {
        log.info('IE Output Payload: ' + cmdbUtil.getOutputPayload());
        log.info('Imported CI: ' + cmdbUtil.getOutputRecordSysId());
```
The `ignore = true` code phrase prevents Import Sets from creating the same record again after it is processed by the identification engine.

**Process**

The identification engine performs identification of each source record before it is inserted into the CMDB. The identification engine determines if the record is a duplicate of an existing CI, and then:

- If not duplicate: Inserts the record to the target table.
- If duplicate: Updates the existing CI in the CMDB, with data from the source record.

The CMDBTransformUtil API pre-processes the source data, then passes the input values to the identification engine with import set being the data source by default. The CMDBTransformUtil API supports a target field that is a reference field in the same manner that Import Sets supports it. The CMDBTransformUtil API also supports a source script, evaluating source scripts to determine the target value which is then passed to the identification engine. For more information, see [Creating a field map](#).

**Specify multiple target tables for an import set**

You can configure each record in an import set with its own target table. Then, instead of inserting all the transformed records into a single target table, the records are inserted into the different target tables that are specified per record. For example, you might need to insert some records from the import set to the Computer class and other records to the Server class.

When importing data using Import Sets, incorporate the following steps:

- In the data source file, add a target table column. Use a string such as "MyTable" to label the column header. In each record row, enter the target table for the record, as a valid CMDB class name such as "cmdb_ci_computer".
- After you Auto Map Matching Fields on the Table Transform Map form, add a field map for the added target table column to establish a relationship between classes and the target tables in the CMDB.

1. In the Field Map related list on the Table Transform Map form, click **New**.
2. Set **Source field** to the header of the target table column that you added in the data source file, such as **MyTable**.
3. Set **Target field** to **Class**.
4. Click **Submit**.

When you configure an import set with multiple target tables as described in the steps above, the **Target table** that is specified on the Table Transform Map form is not used.

**Restrictions**

The following restrictions apply:

- An import set should be associated with a single transform map. While adding a call to the CMDBTransformUtil API, ensure that still a single transform map exists for the import set.
• The CMDBTransformUtil API does not check if mandatory fields have values when used with Import Sets. Regardless of how enforce mandatory fields is set in the transform map, data import fails if a mandatory field does not have a value.
• CI Identification and Reconciliation cannot be applied to Import Sets for dependent CIs (CIs with dependent identification rules).

**CMDB identification rules**

The CMDB identification process relies on identification rules to uniquely identify CIs.

An identification rule applies to a CI class and consists of a single CI identifier and one or more identifier entries and related entries, each with a different priority. Each identifier entry defines a unique attribute set with a specific priority and each related entry defines rules for identifying related items. Create strong identification rules that are set with the highest priority for the strongest identifier entries and related entries.

The identification process and identification rules use the CIs attributes for identification:

**Unique attributes**

Designated sets of criterion attribute values of a CI, that can be used to uniquely identify the CI. Unique attributes can be from the same table or from derived tables.

**Required attributes**

Designated attributes of a CI that cannot be empty.

**Identification rule types**

The steps for identifying dependent CIs can be different from the steps for identifying independent CIs. This difference is reflected in the differences between dependent identification rules and independent identification rules.

**Independent identification rule**

A rule that identifies a CI based on the CI's own attributes, independently of other CIs or relationship.

**Dependent identification rule**

A rule in which identifying a CI requires identifying a dependent CI first. A CI can have dependency on one or more CIs, and a dependent CI can have only a single parent CI with dependency. The relationship types between the CI and its dependent CIs are also included in the identification process. To help with the identification process of dependent CIs, create dependent relationships that define the dependency chain within CI types.

The payload used for identification of a dependent CI, can include a relationship with a qualifier chain. For such relationship, if there is a matching parent/child pair, the system compares the qualifier chain in the payload, with the qualifier chain of the CIs in the database. If there is a difference, the qualifier chain in the database is updated to match the qualifier chain in the payload for that relationship.

**Identifier entries**

You can configure an identifier entry to match a CI not only based on the CI’s own attributes (field-based identification) but also based on the CI’s related list (lookup-based identification) such as Serial Numbers or Network Adapters. The lookup table that is used for identification, needs to have a reference field that points to cmdb_ci.
There are three types of identifier entries:

**Regular identifier entry**

Based on CI's attributes that uniquely identify the CI.

**Lookup identifier entry**

Uses a lookup table (related table) which can be any table that has a reference to the CI that is being identified. After you select a related lookup table, you select identifier attributes from the related table that reference either the cmdb_ci table itself, or one of its descendants.

If the lookup records do not already exist, then they are inserted in the lookup table referenced in the identifier entry.

**Hybrid identifier entry**

A combination of both, a regular identifier entry and a lookup identifier entry.

Example: When discovering virtual machines in a cloud environment which contains two virtual machines with identical serial numbers. A regular identifier entry for the Hardware table such as 

```
[Table: Serial Number, Criterion Attributes: Serial Number, Serial Number Type]
```

cannot uniquely identify these two virtual machines. However, a hybrid identifier entry such as 

```
[Table: Serial Number, Criterion Attributes: Serial Number, Serial Number Type + (Name field from main Hardware table)]
```

can uniquely identify the two virtual machines.

**Guidelines for lookup tables**

Follow these guidelines when specifying a lookup table in an identifier entry.

1. Ensure that lookup tables reference the cmdb_ci table.
2. It is preferable to enforce exact count match (check box Enforce exact count match (Lookup)) for a stronger identification rule. During lookup identification, this option enforces matching only on exact lookup records count match. See Create or edit a CI identification rule for more details.
3. Do not create conflicting identification rules especially for lookup-based rule.

Example: In a CI Identifier for the Hardware class, you specify a lookup-based rule for the Network Adapter class and you also define a CI Identifier for the Network Adapter class. Duplicates might potentially be created in the Network Adapter table, because there are contradicting rules to identify a unique CI in that table:

- One rule that looks only at criterion attributes (CI identifier rule)
- Another rule that looks at criterion attributes and referenced sys_id (lookup rule).

Example: CI with related items that needs to be inserted - sysId is available.

```javascript
const payload = {
  items: [{
    className: 'cmdb_ci_linux_server',
    related: [{
      className: 'cmdb_ci_spkg',
      values: {
        name: 'package1',
        version: 'version1'
      }
    }],
    values: {
      sys_id: '194876usyrr65378098'
    }
  }]
};
```
Related entries

You can define related entries which are rules that are based on related CIs. A related entry is based on a related table which can be any table (CMDB or non-CMDB) that has a reference to the CI that is being identified. Related entries let you create or update records on other tables in which the data is associated with the CI being identified by the identifier entries. Related entries are not used to directly identify CIs.

After you select a related table for the rule, the list in Referenced field is populated with fields from the related table that reference either the [cmdb_ci] table itself, or one of its descendants.

Create or edit a CI identification rule

Identification rules are used to uniquely identify CIs in the CMDB, as part of the identification and reconciliation process. Each CMDB class can be associated with a single identification rule.

Role required: itil has read access, itil_admin (on top of itil) has full access.

In a CI identification rule, specify a CI identifier, and identifier entries and related entries that uniquely identify the CI. You cannot use the CI Class Manager to create related entries for an identification rule, instead, add related entries directly to the cmdb_identifier table.

Review the following before creating identification rules:

- CMDB identification rules
- Effective usage of CMDB Identification

1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list. Select the class for which to create an identification rule.
3. In the class navigation bar, expand Class Info and then click Identification Rule.
4. Click Edit to edit an existing rule, or click Add in the Identification Rule section to create one. Fill out the form, and then click Save.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Independent/Dependent</td>
<td>Designation of whether the CI identifier can identify the CI independently of other CIs, or not.</td>
</tr>
<tr>
<td><strong>Note:</strong> To set the rule as Dependent, you must specify dependent relationship rules for the selected class.</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Name of CI identifier.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the CI identifier.</td>
</tr>
</tbody>
</table>

5. In the Identifier Entries section, click an existing identifier entry to edit, or click Add to create one.
6. In the Identifier Entry dialog box, choose an option and then click Next. Continue with one of the following three steps according to the option you selected.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use attributes from main table &lt;table&gt;</td>
<td>Lets you select attributes from the currently selected table (regular identifier entry).</td>
</tr>
<tr>
<td>Use attributes from another table (Lookup table)</td>
<td>Lets you select attributes from any related table, other than the currently selected table (lookup identifier entry).</td>
</tr>
</tbody>
</table>
7. **Use attributes from main table <table>** option: Set the options on the form and then click **Save**. **Search On Table** is preset to the currently selected table in the CI Classes list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box that specifies the identifier entry is active. At least one identifier entry in an identification rule must be active for the rule to apply.</td>
</tr>
</tbody>
</table>
| Priority               | Priority of the identifier entry. Identifier entries are applied based on priority. Rules with lower priority numbers are given higher priority. Identifier entries of identical priorities are applied randomly.  
                          | You can keep gaps between the priority numbers, so you can assign the unused priority numbers to new entries without modifying the existing priority order.                                                       |
| Criterion Attributes   | Set of attributes that uniquely identify the CI. Attributes can belong to the current class, or to a parent class.                                                                                     |
|                        | It is not possible to add reference fields as a criterion attribute. Reference fields store sys_ids that point to a record in another table, and thus is considered a weak criterion attribute (in terms of uniqueness) for the current table. |
| Allow null attribute   | When selected, then if at least one criterion attribute is not null, allow to attempt matching with an identifier entry even if there are criterion attributes which are null.                                |
|                        | Otherwise, all criterion attributes must have values to attempt matching with an identifier entry.                                                                                                       |
| Allow fallback to parent's rules | Allows the identification rules of the CI's parent to be used if a match is not found for this identification rule. Applies only for dependent identification rules.                                                                 |

**Note:**
- If criterion attributes have only two attributes and **sys_class_name** is one of them (for example [name, sys_class_name], [ip_address, sys_class_name]), then the other attribute cannot be NULL, even if **Allow null attribute** is enabled. This restriction is due to **sys_class_name** being considered a special system matching attribute.
- Optional condition is applicable only for lookup or hybrid identifier entries (and not applicable when using attributes from the main table).
- The Optional condition does not apply, although you are able to customize the default Identifier Entry form by adding the **Optional condition** field. Then navigating to...
8. Use attributes from another table (Lookup table) option:
   a) Set Search On Table to a table other than the currently selected table in the CI Classes list. The Search On Table must have a reference field to cmdb_ci, otherwise the identifier entry is considered invalid.
   b) Set the rest of the fields as described in the previous step.
   c) Optionally, click Advanced options and enter the information for a lookup identifier (scroll down if necessary).

<table>
<thead>
<tr>
<th>Advanced Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All of these conditions must be met</td>
<td>A filter to narrow the set of records that will be searched for a matching CI.</td>
</tr>
<tr>
<td>Enforce exact count match</td>
<td>For lookup identification, match a CI only on exact lookup records count match.</td>
</tr>
<tr>
<td></td>
<td>When enforced, all lookup items for a CI in the payload must have matching records in the lookup table, that reference the same CI:</td>
</tr>
<tr>
<td></td>
<td>1. Only matches CIs that have all the lookup items from the input payload referencing the CI in CMDB.</td>
</tr>
<tr>
<td></td>
<td>2. If there are multiple matches, selects the oldest created CI as the final match.</td>
</tr>
<tr>
<td></td>
<td>When not enforced, one lookup item for a CI in the payload matching a record in the lookup table, is sufficient to consider a match:</td>
</tr>
<tr>
<td></td>
<td>1. Matches any CI that has at least one of the lookup items from the input payload referencing the CI in CMDB.</td>
</tr>
<tr>
<td></td>
<td>2. If there are multiple matches, selects the CIs with the max number of lookup items from the input payload referencing the CI in CMDB.</td>
</tr>
<tr>
<td></td>
<td>3. If there are still multiple matches, selects the oldest created CI as the final match.</td>
</tr>
</tbody>
</table>

d) Click Save.
9. **Use attributes from main and another table (Hybrid) option:**
   a) Set the options on the **General Settings** tab as described in previous steps, and then click **Next**.
   b) On the **Main Table Settings** tab, select the attributes to use from the currently selected table, and then click **Next**.
      - **Search On Table** is preset to the currently selected table in the CI Classes list.
   c) On the **Lookup Table Settings** tab, select a **Search On Table** and then in **Criterion Attributes** select attributes from the specified table. **Search On Table** must have a reference field to **cmdb_ci**, otherwise the identifier entry is considered invalid.
      - You can click **Advanced options** and enter the information for a lookup identifier as described in the previous step (scroll down if necessary).
   d) Click **Save**.

**Note:** The **Allow null attribute** option in the hybrid option, is set to ‘false’. Therefore, all of the selected criterion attributes from both the currently selected table and the lookup table, must have a value.

10. **Optional:** Add related entries to the **cmdb_identifier** table.
   a) In the main platform navigation bar, navigate to **Configuration > Identification/Reconciliation**, and click **CI Identifiers**.
   b) In the **Identifiers** view, locate and click the identification rule that you have been editing or creating.
   c) Click the **Related Entries** tab.
   d) In the **Related Entries** related list, click **New** or open an existing entry to specify a related entry for matching the related item. Fill out the form, and then click **Submit**.

**Related Entry form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier</td>
<td>The CI identifier for which this related entry belongs to. By default it is set to the identifier you previously selected.</td>
</tr>
<tr>
<td>Related table</td>
<td>A related table that references the CI that is being matched.</td>
</tr>
<tr>
<td>Referenced field</td>
<td>A referenced field in <strong>Related table</strong> that should store the referenced CI. This field always references the cmdb_ci table, or a descendent of the cmdb_ci table.</td>
</tr>
<tr>
<td>Criterion attributes</td>
<td>The set of attributes to uniquely identify the related item. Attributes can belong to the current class, or to a parent class. Click the lock icon to view, add, or remove attributes from the identification rule.</td>
</tr>
<tr>
<td>Optional condition</td>
<td>Use the <strong>Add Filter Condition</strong> and the <strong>Add “OR” Clause</strong> buttons to construct a filter to narrow the set of records that will be searched for a matching related item.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that specifies that the related entry is active.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Allow null attribute</td>
<td>If at least one criterion attribute in the related table is not null, allow to attempt matching with an identifier entry even if there are criterion attributes which are null.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of the related entry for the specified <strong>Related table</strong>. Rules with lower priority numbers are given higher priority while matching a related item for specific related table. Related entries for the specified related table with identical priorities are applied randomly. You can keep gaps between the priority numbers, so you can assign the unused priority numbers to new entries without modifying the existing priority order.</td>
</tr>
</tbody>
</table>

**Note:** If criterion attributes have only two attributes and **sys_class_name** is one of them (for example [name, sys_class_name], [ip_address, sys_class_name]), then the other attribute cannot be NULL, even if **Allow null attribute** is enabled. This restriction is due to **sys_class_name** being considered a special system matching attribute.

For example, the pre-defined **Hardware Rule** applies to the Hardware [cmdb_ci_hardware] table. It has an identifier entry with the criterion attribute **Serial Number, Serial Number Type** and its **Search on table** field is set to **Serial Number**.

The following payload snippet adds a CI to the cmdb_ci_linux_server class, that is a child of the Hardware class. It also shows how you can add related items in the payload for which you should create **Related Entries** on the CI Identifier page for the Hardware [cmdb_ci_hardware] table:

```json
{
  "items": [

    {
      "className": "cmdb_ci_linux_server",
      "lookup": [

        {
          "className": "cmdb_serial_number",
          "values": {
            "serial_number": "VMware-42 21 e3 da 44 14 5а a6-56 48 2b 0а 28 53 42 4c",
            "serial_number_type": "system",
            "valid": "true"
          }
        },

        {
          "className": "cmdb_serial_number",
          "values": {
            "serial_number": "4221E3DA-4414-5AA6-5648-2B0A2853424C",
            "serial_number_type": "uuid",
            "valid": "true"
          }
        }
      ]
    }
  ]
}
```
When the **Hardware Rule** is applied, the Serial Number [cmdb_serial_number] table is searched for a match with the values specified within the lookup key. Unless **Enforce exact count match (Lookup)** is checked, it is not necessary for every lookup key to return a match, as long as there is at least one match. If all matches reference the same CI, then that CI is considered to be the existing CI record. If no match is found, then the identification search continues to the next rule entry. If after all the rules are exhausted without finding a match, a new CI record is created in the database.

You can optionally **create an inclusion rule** to narrow the scope of CIs that are included in identification.

**Create an identification inclusion rule**

Narrow the scope of CIs that are included in the identification process by creating an identification inclusion rule.

Role required: itil has read access, itil_admin (on top of itil) has full access.

During duplication detection of independent CIs, the identification and reconciliation engine (IRE) processes only the CIs that satisfy the identification inclusion rules. For example, you can set a filter to include only CIs whose state is operational. When no identification inclusion rules exist, all CIs are included in the identification process and in the CMDB Health duplicate metric calculations. In the base system, there are no predefined identification inclusion rules. Identification inclusion rules are defined at the class level.

Identification inclusion rules also indirectly impact what appears in CMDB health dashboards for duplicate CIs, in addition to any health inclusion rules.
Identification inclusion rules can prevent the identification of certain types of CIs, affecting some features of Discovery and Service Mapping.

1. Navigate to **Configuration > CI Class Manager**.
2. Click **Hierarchy** to display the CI Classes list. Select the class for which to create an identification inclusion rule.
3. In the class navigation bar, expand **Class Info** and then click **Identification**.
4. In the Inclusion Rule (Advanced) section, click **Add** to create a rule or click **Edit** to edit an existing rule. In the Create Inclusion Rules dialog box, specify a criteria in the **Active record condition** field. CIs must meet this criteria to be included in the identification process and in the duplicate CMDB Health metric.
5. Click **Save**.

Navigate to **Configuration > Identification/Reconciliation > Identification Inclusion Rules** to see the list of all identification inclusion rules.

**Reconciliation rules**

Reconciliation rules specify which data sources can update a table or a set of table attributes, and they can be defined at the parent and the child table level. Ensure that there is a reconciliation rule for each data source that is authorized to update an attribute - multiple reconciliation rules can exist for the same set of attributes.

Data sources are used with the **createOrUpdateCI()** API to simulate manual updates to CIs. EventManagement, ImportSet, ManualEntry, and Tivoli are examples of data sources.

As you create reconciliation rules, keep the following principles and guidelines in mind. These principles are designed for flexibility and the refinement of rules at the attributes level.

**Example reconciliation rules**

For example, you might have the following reconciliation rules. The rules are created for the cmdb_ci_computer table and one of its child tables, the cmdb_ci_linux_server table. The rules specify the following:

1. Discovery is exclusively authorized to update the **name** attribute in the cmdb_ci_computer table.

   Because reconciliation rules are derived by child tables from parent tables, this rule also authorizes Discovery to update the **name** attribute in any child tables for the cmdb_ci_computer table.

2. ServiceWatch is exclusively authorized to update the **name** attribute in the cmdb_ci_linux_server table.

3. ServiceWatch is exclusively authorized to update all attributes in the cmdb_ci_linux_server table, as configured by leaving the **Attributes** field empty in the rule.

**Authorization for all attributes in a table**

If you want to authorize a data source to update all attributes in a table, leave the attribute list empty in the reconciliation rule for the data source. However, this authorization can be overridden for some of the attributes by rules for child tables in which specific attributes are listed.
For example, if only example rules #1 and #3 are created, then Discovery is authorized to update the **name** attribute in the cmdb_ci_linux_server table. ServiceWatch is authorized to update all other attributes in the table except for the **name** attribute.

To override the authorization of Discovery to update the **name** attribute, example rule #2 is added to specifically authorize ServiceWatch to update the attribute.

**Authorization to only specific attributes in a table**

If you want to authorize a data source to update specific attributes in a table, list these attributes in the reconciliation rule for the data source. A rule that grants access to specific attributes in a table overrides other rules with an empty attribute list that grants access to the entire table.

Example rule #1 grants Discovery with exclusive authority to update the **name** attribute of the cmdb_ci_computer table. All other data sources are prevented from updating the **name** attribute of any CI in the cmdb_ci_computer table.

**Child table rules overrides parent table rules**

Any reconciliation rules defined for a child table override the rules defined for its parent table.

For example, rule #1 lets Discovery update the **name** attribute in the cmdb_ci_computer table and all of its child tables. However, rule #2 for the cmdb_ci_linux_server child table, which overrides rule #1 for the parent table, explicitly authorizes ServiceWatch to update this attribute in the child table.

As a result:

- Discovery cannot update the **name** attribute of the child cmdb_ci_linux_server table. Only ServiceWatch is authorized to update this attribute.
- Discovery is authorized to update the **name** attribute of CI records in all other child tables of the cmdb_ci_computer table.

**Overlapping rules**

Rules that authorize different data sources for the same attributes of the same table can coexist and do not exclude each other.

For example, assume the following rule is added. It is similar to example rule #1 but authorizes a different data source:

- ServiceWatch is authorized to update the **name** attribute in the cmdb_ci_computer table.

Like example rule #1, this new rule applies to the **name** attribute in the cmdb_ci_computer table so both Discovery and ServiceWatch can update the attribute. Any applicable data source precedence rules are enforced to prevent the data sources from overwriting each other's updates.

**Domain separation**

If Domain Separation is enabled, then you can scope reconciliation rules to specific domains. Rules of the parent domain, if not overridden, apply to CIs of child domain. All rules that are visible to a domain are applied, and a rule overriding the parent domain displays the child domain version.
Create or edit a CI reconciliation rule

A reconciliation rule specifies the attributes that a data source is authorized to update for a given table and prevents unauthorized data sources from overwriting the attributes' values. If an attribute does not have any reconciliation rules created for it, data sources are allowed to overwrite each other's updates to the attribute's value.

Role required: itil has read access, itil_admin (on top of itil) has full access.

Reconciliation rules are used in conjunction with data refresh rules and data source precedence rules to determine reconciliation steps for a CI. These rules determine if, when, and by which data source a CI can be updated.

Precedence order of reconciliation rules:

• Rule configured for a specific attribute, has precedence over rule set with Apply to all attributes (regardless of priority value).
• Between 2 rules for same attribute or between 2 rules set with Apply to all attributes, the rule that is specific directly for the class has precedence over the derived rule.
• Between 2 rules for same attribute or between 2 rules set with Apply to all attributes at same class level, precedence is determined by rule priorities.

1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to open the CI Classes list. Then select a class for which to create a reconciliation rule.
3. In the class navigation bar, expand Class Info and then click Reconciliation Rules.
4. In the Reconciliation Rules section, click Add to create a rule or select an existing rule to edit.
5. In the Create Reconciliation dialog box, fill out the fields on the Rule Info tab, and then click Next.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>The data source that you are configuring this rule for.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate this reconciliation rule.</td>
</tr>
</tbody>
</table>

6. In the Create Reconciliation dialog box, fill out the fields on the Attributes tab, and then click Next.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply to All Attributes</td>
<td>Authorizes the specified source to update all table attributes.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Attributes that the data source is authorized to update. You can select attributes from the current class, or a parent class. Available only if Apply To All Attributes is false.</td>
</tr>
</tbody>
</table>

Note: This rule will be overridden by any rule that applies to a specific attribute. In which case, instead of using this option, you can directly include all attributes for Attributes.
Field | Description
--- | ---
Update with Null | Attributes that the data source can update with a null value. By default, authorized data sources cannot overwrite a non-null value with a null value. Attributes in this list, which are not in the Attributes list, are not included with the attributes that the data source can update with a null value.

7. In the Create Reconciliation dialog box, fill out the fields on the Filter Condition tab if applicable.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Filter Condition | Conditions that a CI must meet, in order for the rule to apply to that specific CI. For example, to apply this rule only to CIs that are associated with the Finance department, select this condition: `[Department] [is] [Finance]`

8. Click Save.

Additional rules that affect reconciliation:
1. Define or edit data source precedence rules
2. Create data refresh rules

**Define or edit data source precedence rules**

If multiple data sources are authorized to update the same table or the same table attributes in the CMDB, assign a priority to each of these data sources to prevent them from overwriting each other’s updates. Without data source precedence rules, data sources can overwrite each other’s modifications.

Role required: itil has read access, itil_admin (on top of itil) has full access.

Data source precedence rules are used along with data refresh rules and reconciliation rules to determine reconciliation steps for a CI. These rules determine if, when, and by which data source a CI can be updated.

After an authorized data source updates an attribute, subsequent updates are accepted only from the same data source or from a data source with a higher priority. Updates from a data source with a lower priority are rejected, unless these two conditions are met:

- The lower propriety source is the first source updating the CI.
- The CI became stale based on data refresh rules for the CI class.

Information about the last data source that updates each attribute is stored in the Data Source History [cmdb_datasource_last_update] table.

Data source precedence rules affect reconciliation of stale CI attributes. During reconciliation, the information in the Data Source History table is considered along with the data refresh rules for the CI’s class, to determine if a CI attribute is stale. A CI attribute is determined to be stale if it was not updated by the latest data source to update the CI, within a time period. The time period is specified by the Effective Duration time in the data refresh rule for the class for the data source. In this case, if another authorized data source, with a lower priority attempts to update the stale CI attribute, the update is allowed.
1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list. Select the class for which to create a data source precedence rule.
3. In the class navigation bar, expand Class Info and then click Reconciliation Rules.
4. In the Data Precedence Rules section, click Add to create a rule or select an existing rule to edit. Fill out the details in the Create Precedence Rules dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>The data source that this precedence rule applies to. EventManagement, ImportSet, ManualEntry, or an application such as Tivoli are examples of a data source.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of this precedence rule within the set of precedence rules for the specified table. Smaller numbers designate higher priority. Data sources without a precedence rule are assigned the lowest priority.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate this precedence rule.</td>
</tr>
</tbody>
</table>

5. Click Save.

Create data refresh rules

Specify data refresh rules to determine if a CI is stale for a specific data source. Such CIs can then be updated by a lower-priority authorized data source.

Role required: itil has read access, itil_admin (on top of itil) has full access.

Data refresh rules are used in conjunction with data source precedence rules and reconciliation rules to determine reconciliation steps for a CI. These rules determine if, when, and by which data source a CI can be updated.

1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list. Select the class for which to create a data refresh rule.
3. In the class navigation bar, expand Class Info and then click Reconciliation Rules.
4. In the Data Refresh Rules section, click Add to create a rule or select an existing rule to edit. Fill out the details in the Create Data Refresh Rules dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Data source of the class.</td>
</tr>
<tr>
<td>Effective Duration</td>
<td>The time period that is used for the staleness test.</td>
</tr>
<tr>
<td></td>
<td>If the fields specified in the reconciliation rule for the CI's class were not updated by the specified data source within the specified time period — the CI is determined to be stale for that data source.</td>
</tr>
<tr>
<td></td>
<td>If you enter a value with a prefix that is valid and a suffix that is not, such as 15 x — the valid portion of the value is used (&quot;15&quot;). If the entire value is invalid — the default value of 0 is used.</td>
</tr>
</tbody>
</table>
5. Click Save.

Detecting duplicate CIs

When the identification process encounters duplicate CIs, it groups each set of duplicate CIs into a de-duplication task for review and remediation. A large number of duplicate CIs might be due to weak identification rules. You can configure the identification engine to reconcile duplicate CIs.

During CMDB Identification, processing of duplicate CIs is determined by the properties `glide.identification_engine.skip_duplicates` (set to true by default) and `glide.identification_engine.skip_duplicates.threshold` (set to 5 by default), and on the number of duplicate CIs that are detected. You can configure these properties so duplicate CIs are automatically reconciled, skipping duplication.

- If `glide.identification_engine.skip_duplicates` is true, and the number of duplicate CIs is less than the threshold specified by `glide.identification_engine.skip_duplicates.threshold`, then the oldest of the duplicate CIs is picked as a match and gets updated. That oldest duplicate CI also becomes the master CI for that set of duplicate CIs. The rest of the duplicate CIs are tagged as duplicates by setting the `cmdb_ci's duplicate_of` to the appropriate master CI. During matching, the identification engine filters out any CI that is tagged as duplicate of any CI.
- If `glide.identification_engine.skip_duplicates` is false, then matching of duplicate CIs fails with an error, and none of the duplicate CIs are updated.

Note: In either case, de-duplication tasks are always created.

For more information about these properties, see Properties for Identification and Reconciliation.

Review de-duplication tasks

For information about reviewing and remediating de-duplicate tasks, and how the master CI is used, see Duplicate CIs.

Generate and simulate payload execution using identification simulation

Identification simulation is a central location for automatically constructing a payload that is guaranteed to be complete and valid. You can then simulate the processing of the payload by the identification and reconciliation engine (IRE) and examine the results before actually submitting it for execution by IRE.

Use identification simulation to construct an input payload, and simulate processing of the payload by IRE. You can then examine the results, adjust identification rules if needed, and re-run the simulation of the updated payload.

Use the identification simulation to:

- Automatically construct input payload that is based on existing identification rules, hosting and containment rules.
- Simulate execution of a payload (automatically constructed by identification simulation, or manually created).
- Browse payload output and execution log messages for a simulated run.
Note: Identification simulation does not commit any updates to the CMDB.

Automatically generate payload using identification simulation

Use identification simulation to automatically construct an input payload for a specified class. The constructed payload is complete with any required dependent CIs, correctly structured, and syntactically valid for processing by the identification and reconciliation engine (IRE).

Role required: admin

The payload that is constructed during identification simulation is for the specified class. For a dependent CI class, you will be prompted for information about all dependencies. After you provide the required details, identification simulation constructs the payload based on your input.

1. Navigate to Configuration > Identification/Reconciliation, and click Identification Simulation.
2. In the Start with CI Class box click Start.
3. On the Payload Information form, in the Data source field, select the data source that is associated with this class update.
   For the ServiceNow Discovery data source, select ServiceNow.
4. Select the Class in the payload.
   a) In the Criterion Attributes area select the CI identifier attributes and then specify the values that uniquely identify a CI.
   b) In the Additional Attributes area specify attributes and values that matching CIs will be updated with.
5. For dependent CIs associated with dependent identification rules, fill out the Criterion Attributes and Additional Attributes sections in all Container level sections that display.
6. Click Generate Script. If any errors indicate that there are missing fields, fill in the missing fields and then click Generate Script again.

   • Click Run Simulation to simulate processing of the payload by IRE.
   • Examine the results of the simulation, fine-tune the payload as needed, and combine with other payloads for other classes as desired. After finalizing the payload, use the createOrUpdateCI() API to execute the payload by IRE which will result in actual updates to the CMDB.
   • Click Copy Script to copy the JSON script into the clipboard. You can then paste that script into a third party software or to another screen of the identification simulation.

Simulate payload processing using identification simulation

Use identification simulation to simulate the identification and reconciliation engine (IRE) process of CI identification for an input payload. Provide a valid payload, which was constructed using identification simulation or that was created manually.

Role required: admin

1. Navigate to Configuration > Identification/Reconciliation, and click Identification Simulation.
2. Optional: To run a simulation of an existing payload:
   a) Click Start in the Start with Existing Payload tile.
   b) In the Data source field, select the data source that is associated with this class update.
   c) Paste the JSON payload into the empty canvas.
3. Optional: To construct a new payload click Start in the Start with CI Class tile. See Automatically generate payload using identification simulation for more information.
4. Click Run Simulation to simulate processing of the payload by IRE.
1. Examine the results of the simulation in the results pane, and fine-tune the payload as needed:
   a. Click Run #1 to display the Context ID and the Run ID of the simulated run.
   b. Click the drop down arrow next to Run #1 to display additional details.
      - **Input**: Displays the payload for the simulation.
      - **Logs**: Displays all the logged messages that IRE generated while simulating processing of the payload, according to the specified logging level.
      - **Output**: Displays the output payload returned by IRE.

2. After finalizing the payload, use the createOrUpdateCI() API to execute the payload by IRE which will result in actual updates to the CMDB.

**Set logging level for identification simulation**

Identification simulation logs each step of a simulated payload processing. You can then examine these run logs to determine if a payload was processed as expected, and if identification rules are effective. You can adjust the level of logging so it is helpful, and so that the amount of messages is not excessive or insufficient.

Role required: admin

1. Navigate to Configuration > Identification/Reconciliation, and click Identification Simulation.
2. Click the Settings icon.
3. Select logging level for the identification and reconciliation engine (IRE) under IE Log Level and for the service cache under Service Cache Log Level.
   - The logging levels are displayed in ascending order, from the minimum level to the maximum level of logging.
4. Click on the Settings icon again to close the Settings dialog box.

**Examine run logs**

Identification simulation provides run logs which are generated by Identification and Reconciliation Engine (IRE). You can access these run logs for payload runs, to examine results and for debugging purposes. IRE payload output logs appear in a user friendly format on a central page.

Role required: admin

Also, internal applications that use IRE (such as Discovery) can call an internal API to provide a URL to viewing IRE run logs.

Logging is in the context of a specific run of the identification engine, and you can filter the log list by a specific data source and time range. Up to 1000 run logs that are up to 2 months old are listed, grouped by Context IDs, and run times. You can use the glide.identification_logs.max_run_ids property to modify the 1000 limit.

You can control the logging level by using the glide.discovery.identification.log_level Discovery system property and setting the value to one of the following:

- Info
- Warn
- Error
- Debug
- DebugVerbose
- DebugObnoxious
Note: IRE performs an initial verification of a payload before processing identification rules. If IRE detects any duplicate CIs based on any class identifiers, the payload is rejected and processing stops.

1. Navigate to Configuration > Identification/Reconciliation > Identification Logs.
2. Filter the runs list as follows:
   a) Source: Select the data source for which to display run logs.
   b) Time Range: Specify a time range for which to display run logs.

The Runs list displays all runs for the specified data source, during the specified time range.

3. In the Runs list, click a Run # to display its Context ID and Run ID.
   A unique Context ID is associated with each specific payload that is run. Each run of that payload, is associated with a unique Run ID. A single Context ID for a payload that is run multiple times is associated with multiple Run IDs.

4. Click the drop down arrow for a Run # to display additional details.
   • Input: Displays the payload for the run.
   • Logs: Displays all the logged messages that the identification engine generated while running the payload, according to the specified logging level.
   • Output: Displays the output payload returned by the identification engine.

IRE error messages
The Identification and Reconciliation Engine (IRE) generates the following errors, which are displayed in the Identification Logging pane and in the system logs.

For information about lookup-based CI identification and qualifier chains, see Create or edit a CI identification rule.

Note: IRE performs an initial verification of a payload before processing identification rules. If IRE detects any duplicate CIs based on any class identifiers, the payload is rejected and processing stops.

Error: IDENTIFICATION_RULE_MISSING

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Identity Rule Missing for table [xyz] | **Description:**
| | Identification rule is missing for a class.
| | **Resolution:**
| | Ensure that there is an identification rule for table [xyz], and that the rule is active. |
### MISSING_MATCHING_ATTRIBUTES

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| In payload missing minimum set of input values for criterion (matching) attributes from identify rule for table \([xyz]\). Add these input values in payload item ‘\(abc\)’                                                                 | **Description:**  
Missing minimum set of values for criterion attributes for an identification rule.  

**Resolution:**  
In the payload, add minimum set of values for criterion attributes for CI Identifier for table \([xyz]\).  
Open the CI Class Manager, click **Hierarchy** and select the \([xyz]\) class. Check the identification rule and the identifier entries for table \([xyz]\). |

### Error: NO_CLASS_NAME_FOR_INDEPENDENT_CI

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Cannot have 'sys_class_name' as a key field in an Independent Identity Rule on 'xyz'                                                                                                                     | **Description:**  
The class attribute was added to the CI identifier which is not supported.  

**Resolution:**  
Remove the class attribute from CI Identifier for table \([xyz]\). |

### Error: IDENTIFICATION_RULE_FOR_LOOKUP_MISSING

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Identity Rule for table \([xyz]\) missing Lookup Rule for class \([abc]\)                                                                                                                                     | **Description:**  
The payload has a lookup class name, but the corresponding lookup rule is missing.  

**Resolution:**  
Add lookup identifier entry with [Search on table] as \([abc]\) for CI Identifier for table \([xyz]\). |
### Error: IDENTIFICATION_RULE_FOR_RELATED_ITEM_MISSING

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Identity Rule for table [xyz] missing Related Rule for class [abc] | **Description:** The payload has a related class name, but the corresponding related rule is missing.  
**Resolution:** Add related entry with [Related table] as [abc] within CI Identifier for table [xyz]. |

### Error: NO_LOOKUP_RULES_FOR_DEPENDENT_CI

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Cannot have Lookup Rule for a Dependent Identity Rule on `xyz` | **Description:** Cannot have Lookup Rule for a Dependent Identity Rule.  
**Resolution:** Remove lookup identifier entry from dependent CI Identifier for table [xyz]. |
### Error: INVALID_INPUT_DATA

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Found invalid sys_id in payload. No record with sys_id [xyz] exist in table [abc] or is a duplicate record with [duplicate_of] field set to a master CI | Description:  
The payload has a reference to an invalid sys_id.  
Resolution:  
Remove the referenced sys_id, or provide a valid sys_id. |
| In payload no data source exist. You need to provide choice value from choice field [discovery_source] in table [cmdb_ci] | Description:  
In payload no data source exists.  
Resolution:  
In the payload, provide a valid choice value from choice field [discovery_source] from table [cmdb_ci]. |
| In payload invalid data source [xyz] exist. You need to provide a valid choice value from field [discovery_source] in table [cmdb_ci] | Description:  
The payload contains an invalid data source.  
Resolution:  
In the payload, provide a valid choice value from choice field [discovery_source] from table [cmdb_ci]. |
| No such relationship with name [xyz] exist in table [cmdb_rel_type]. If out-of-box relationship for [xyz] has been removed or renamed, it should be restored | Description:  
The payload is referencing a relationship that does not exist in the [cmdb_rel_type] table.  
Resolution:  
Verify that the reference to the relationship is accurate. Or, if it is a new relationship, add it to the [cmdb_rel_type] table. Or, If out-of-box relationship for [xyz] has been removed or renamed, restore it. |
| Payload relations ‘xyz’ has invalid parent record index: [0] | Description:  
Payload references invalid parent indexes.  
Resolution:  
Check payload indexes and ensure that they are all valid. |
| Payload relations ‘xyz’ has invalid child record index: [0] | Description:  
Payload references invalid child indexes.  
Resolution:  
Check payload indexes and ensure that they are all valid. |
### Error: DUPLICATE_RELATIONSHIP_TYPES

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate relationship type records exists with name [\texttt{xyz}] in table [cmdb_rel_type] having sys_ids: [\texttt{abc}]</td>
<td><strong>Description:</strong>&lt;br&gt;There are duplicate records in the [rel_ci_type] table for the relationship.&lt;br&gt;<strong>Resolution:</strong>&lt;br&gt;Remove the duplicate records.</td>
</tr>
</tbody>
</table>

### Error: DUPLICATE_PAYLOAD_RECORDS

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Found duplicate items in the payload (index 0 and 1), using className [\texttt{xyz}] and fields [\texttt{abc}]. Remove duplicate items from payload</td>
<td><strong>Description:</strong>&lt;br&gt;The payload contains two items whose criterion attributes have identical values.&lt;br&gt;<strong>Resolution:</strong>&lt;br&gt;Remove one of the duplicate items.</td>
</tr>
</tbody>
</table>

### Error: LOCK_TIMEOUT

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed to acquire synchronization lock for \texttt{xyz}</td>
<td><strong>Description:</strong>&lt;br&gt;Failed to acquire the system mutex lock.&lt;br&gt;<strong>Resolution:</strong>&lt;br&gt;Increase the mutex expiration time by adding the system property <code>glide.identification_engine.mutex_expiration_time</code> and setting to an integer value that is greater than the default value (15 min).</td>
</tr>
</tbody>
</table>
## Error: MULTIPLE_DUPLICATE_RECORDS

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Found duplicate records in table [xyz] using fields [abc]</td>
<td>Description:</td>
</tr>
<tr>
<td></td>
<td>Found duplicate records in the specified table.</td>
</tr>
<tr>
<td></td>
<td>Resolution:</td>
</tr>
<tr>
<td></td>
<td>Fix the duplicate records found by the identification engine. Check de-duplication tasks for information about all duplicates.</td>
</tr>
</tbody>
</table>

## Error: REQUIRED_ATTRIBUTE_EMPTY

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Missing mandatory field [xyz] in table [abc]. Add input value for mandatory field in payload</td>
<td>Description:</td>
</tr>
<tr>
<td></td>
<td>A required attribute is missing in the payload.</td>
</tr>
<tr>
<td></td>
<td>Resolution:</td>
</tr>
<tr>
<td></td>
<td>In the payload, add input value for mandatory field [xyz] in table [abc].</td>
</tr>
</tbody>
</table>

## Error: MISSING_DEPENDENCY

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>In payload no relations defined for dependent class [xyz] that matches any containment/hosting rules: [abc]. Add appropriate relations in payload for 'def'</td>
<td>Description:</td>
</tr>
<tr>
<td></td>
<td>No relations defined for the dependent class that matches any of its metadata rules.</td>
</tr>
<tr>
<td></td>
<td>Resolution:</td>
</tr>
<tr>
<td></td>
<td>In payload add appropriate relations for dependent class [xyz] that matches any containment/hosting rules: [abc].</td>
</tr>
</tbody>
</table>
## Error: METADATA_RULE_MISSING

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| No containment or hosting rules defined for dependent class [xyz]. Add containment/hosting rules for abc | **Description:**
There are no containment or hosting rules defined for dependent class.

**Resolution:**
Add containment or hosting rules for dependent class [xyz]. |

## Error: MULTIPLE_DEPENDENCIES

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Found multiple dependent relation items [xyz] and [abc] in payload | **Description:**
Multiple dependent relation items exist.

**Resolution:**
Remove one of the multiple dependent relation items [xyz] or [abc]. |

Multiple paths leading to the same destination: xyz -> abc | **Description:**
Multiple paths leading to the same destination.

**Resolution:**
Remove duplicate relationship/qualifier chains that might exists between xyz -> abc.
<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandoning processing payload item 'xyz', since its depends on payload item 'abc' has errors</td>
<td>Description: Dependent payload item has errors, so abandoning processing. Resolution: Resolve the error on the dependent payload item 'abc'.</td>
</tr>
<tr>
<td>Can't find matched record with sys_id [xyz] in table [abc]</td>
<td>Description: Matched sys_id does not exist in the corresponding table. Resolution: Check in table [abc] whether matched record is a valid record based on input payload.</td>
</tr>
<tr>
<td>Identification engine API got called recursively, aborting...</td>
<td>Description: The Identification engine API was called recursively. Resolution: Avoid calling the Identification engine API recursively.</td>
</tr>
<tr>
<td>Detected error while processing payload from xyz</td>
<td>Description: Error occurred during processing payload. Resolution: Resolve all errors mentioned in the output payload from xyz.</td>
</tr>
<tr>
<td>While processing relations encountered errors in payload item: xyz</td>
<td>Description: Payload item has errors. Resolution: Resolve errors in payload item 'xyz'.</td>
</tr>
<tr>
<td>Error occurred during parsing input json payload: xyz</td>
<td>Description: Error occurred during parsing JSON payload. Resolution: Ensure that input JSON payload has correct JSON format.</td>
</tr>
</tbody>
</table>
Error: MULTI_MATCH

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Duplicate dependent records found having relationship [xyz] with same CI (className:[abc], sysId:[def]) | **Description:**  
Found duplicate dependent CIs.  
**Resolution:**  
Check de-duplication tasks for information about all duplicates, and then delete duplicate records. |
| Found multiple relations between payload items: ‘xyz’ and ‘abc’ | **Description:**  
Found multiple relations between payload items.  
**Resolution:**  
Check for duplicate relationship chains and qualifier chains that might exist. |
| Found duplicate records in lookup table [xyz] using fields [abc] and reference field [def] | **Description:**  
Found duplicate records in lookup table.  
**Resolution:**  
Check de-duplication tasks for information about all duplicates, and then delete duplicate records. |

Error: QUALIFICATION_LOOP

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Qualification chain has loop that contains relation ‘xyz’ | **Description:**  
Qualification chain has a loop.  
**Resolution:**  
Remove the loop from the qualification chain with relation ‘xyz’. |

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Error: TYPE_CONFLICT_IN_QUALIFICATION

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid payload, qualification chain has multiple possible paths for payload items: 'xyz' and 'abc'</td>
<td><strong>Description:</strong> Multipe qualification paths found.</td>
</tr>
<tr>
<td></td>
<td><strong>Resolution:</strong> Remove multiple possible qualification paths between items 'xyz' and 'abc'.</td>
</tr>
</tbody>
</table>

## Error: RECLASSIFICATION_NOT_ALLOWED

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Reclassification not allowed from class: [xyz] to [abc]</td>
<td><strong>Description:</strong> CI reclassification not allowed.</td>
</tr>
<tr>
<td></td>
<td><strong>Resolution:</strong> Check reclassification tasks for information about reclassification, and check if reclassification from class: [xyz] to [abc] is valid.</td>
</tr>
</tbody>
</table>

## Error: DUPLICATE_RELATED_PAYLOAD

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Found duplicate Related items (0 and 1) in the payload index 1 using fields xyz</td>
<td><strong>Description:</strong> Duplicate Related items present.</td>
</tr>
<tr>
<td></td>
<td><strong>Resolution:</strong> Remove one of the duplicate related items present in the payload.</td>
</tr>
</tbody>
</table>
Error: DUPLICATE_LOOKUP_PAYLOAD

<table>
<thead>
<tr>
<th>Message</th>
<th>Description and Resolution</th>
</tr>
</thead>
</table>
| Found duplicate Lookup items (0 and 1) in the payload index 1 using fields xyz | **Description:** Duplicate lookup items present.  
**Resolution:** Remove one of the duplicate lookup items present in the payload. |

**CI reclassification**

During the CI identification process, a CI might need to be reclassified to a different `sys_class_name` type. By default, CIs are reclassified automatically. If automatic reclassification is disabled, then the CI is not reclassified and the system generates a reclassification task for your review.

A CI can be upgraded to a higher class, downgraded to a lower class, or switched to a different branch in the class hierarchy. For more details about reclassification operations, see Reclassify a CI. You can configure CI reclassification behavior at a system-wide level or individually per CI.

**Note:** CI reclassification is possible only between two classes that have identical identification rules.

**Enabling and disabling automatic CI reclassification**

You can use the following properties to configure system-wide behavior for CI reclassification, enabling or disabling automatic reclassification updates specified in a payload. These properties are set to `true` in the base system, enabling processing of CI updates including CI reclassification updates. To disable any automatic reclassification update, set the respective property to `false`. In that case, IRE rejects a payload with the respective reclassification updates, and creates a reclassification task.

- `glide.class.upgrade.enabled`
- `glide.class.downgrade.enabled`
- `glide.class.switch.enabled`

For more information about CI reclassification related properties, see Properties for Identification and Reconciliation.

Alternatively, you can control the reclassification behavior for individual CIs in the input payload of the `createOrUpdateCI()` API. In the payload, you can set these properties to `true` or `false` to temporarily override the respective property setting.

- `classUpgrade`
- `classDowngrade`
- `classSwitch`

The following sample JSON payload enables automatic reclassification for the specified CI:

```json
{ items: [{className: 'cmdb_ci_server', classUpgrade: true, classDowngrade: true, classSwitch: true, values: {name: 'linux123', serial_number: '12srt567', ip_address: '10.2.3.4'}}, ]}
```
View a reclassification task

When automatic CI reclassification is disabled, reclassification tasks are created for CIs that could not be automatically reclassified during the identification process. Review these tasks to locate the CIs and decide if to reclassify them.

Role required: admin or itil

1. Navigate to Configuration > Identification/Reconciliation > Reclassification Tasks.
2. Select a reclassification task.
3. Examine the details on the Reclassification Task form.

Reclassification Task form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration item</td>
<td>The CI that must be reclassified.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description noting that CI reclassification was not allowed.</td>
</tr>
<tr>
<td>Description</td>
<td>Description noting the current class of the CI and the class that the CI must be changed to.</td>
</tr>
<tr>
<td>Internal payload</td>
<td>Payload used in the identification process.</td>
</tr>
</tbody>
</table>

After examining the task details, you can locate the CI that is noted in the task Description and manually reclassify it. For details, see Reclassify a CI.

CMDB dependent relationship rules

Service definitions consist of CI types and relationship types. Dependent relationship rules define the dependency structure of the CI types and the relationship types in these service definitions, helping in CI identification and in the construction of business service maps.

The dependencies that are defined by these rules are used when identifying dependent CIs to prioritize the order of CI identification, and to match CIs and respective dependent CIs in a payload. Dependent relationship rules are also used by Service Mapping and can be defined for custom CI types. After defining a new CI type, you can define dependent relationship rules that specify how the new CI type is related to existing types in the CMDB.

Dependent relationship rules consist of hosting and containment rules (dependent relationship rules), each type modeling the data from a different perspective of the CI. Containment rules represent CIs’ configuration hierarchy, describing which CI contains which other CIs. Hosting rules represent CIs’ placement in a business definition, describing what CIs run on.

Both hosting and containment rules describe a relationship type between two CI types and the same relationship type can be used in a hosting rule and in a containment rule. It is the context in which the relationship is used that distinguishes between a containment and hosting rule.

Manage dependent relationship rules:

- To access rules at the class level, use the CI Class Manager. Navigate to Configuration > CI Class Manager.
- To access grouped rules, use the Metadata Editor. Navigate to Configuration > Identification/Reconciliation > Metadata Editor.

The plugins that have been activated on an instance determine which hosting and containment rules exist in a base system.
Hosting rules

Hosting rules represent all the possible valid combinations of pairs of hosting and hosted CIs in the service definition. Hosting rules are a flat set of rules that can be only one level deep, and which always involve resources, typically physical or virtual hardware. Each hosting rule is a stand-alone rule between two CI types, describing either a valid CI type that another CI type can host, or by which another CI type can be hosted. A hosting rule consists of a parent CI type, a relationship type (such as Hosted On::Hosts) and a child CI type. For example, you can have a hosting rule that specifies that the CI type ‘Application’ ‘Runs On::Runs’, the CI type ‘Hardware’.

A CI can be hosted on multiple resources (such as Windows and Linux). This CI is represented by a hosting rule for the CI with each resource that the CI can be hosted on. During CI identification, the pair of CIs that are being examined, should satisfy at least one hosting rule.

Hosting rules are stored in the CMDB Metadata Hosting Rules [cmdb_metadata_hosting] table.

Containment rules

Containment rules represent the containment hierarchy for a CI type, describing valid objects that a CI type can contain in the service definition, and valid objects that can be contained by the CI type. Containment rules are chained to each other in a containment rules group, with a CI type that is the top-level (root) parent of the group. The collection of containment rules construct a hierarchy-like map of containment relationships. Containment rules are logical concepts used to represent logical CIs, for example to describe software that runs on a server. A containment rule consists of a parent CI type, a relationship type (such as ‘Contained By::Contains’), and a child CI type. For example, you might have a containment rule specifying that the CI type ‘Tomcat’ ‘Contains::Contained By’ CI type ‘WAR File’.

Endpoints are special containment rules that specify incoming or outgoing connections in the model, designating the CI types that data of some specified type flows in to or out from the service definition. After adding an endpoint to a containment rule, you cannot add any child rules to the endpoint rule.

Containment rules are stored in the CMDB Metadata Containment Rules [cmdb_metadata_containment] table.

Reference rules

Reference rules are used mostly by Cloud Management to represent all of the possible valid combinations of pairs of referencing and referenced CIs in the service definition.

- Reference rules are a flat set of rules that can be only one level deep.
- Reference rules always involve resources, typically virtual entities. Each reference rule is a stand-alone rule between two CI types, describing either a valid CI type that another CI type can reference, or by which another CI type can be referenced. Both the CI classes should be able to live independent of each other.
- A referencing rule consists of a parent CI type, a relationship type (such as Provisioned From::Provisioned) and a child CI type. For example, you can have a referencing rule that specifies that the CI type ‘Virtual Machine’ Provisioned From::Provisioned, the CI type ‘Image’.
- A CI can reference multiple resources (for example, a VM Instance can have a reference relation with both the Image and the Hardware templates). This CI is represented by a referencing rule for the CI with each resource that the CI can be referenced from.
- The reference rule cannot be part of the CI identification.
Rules requirements

The rules that you create are bound by the following requirements which narrow the relationships and ensure that only valid options are available in the drop-down lists in the Metadata Editor.

- Given a CI type that is as a child in a containment rule: Not this CI type or its children can be a top-level (root) parent of any other containment rule, and it cannot be in any hosting rule, either as a parent or as a child.
- Given a CI type that is a top-level (root) parent of a containment rule: It cannot be a child in a hosting rule (for example, you cannot be hosted on Tomcat, if Tomcat has any containment rules).
- Given a CI type that is a child in a hosting rule: It cannot be in any containment rule, either as a parent or a child.
- Given a CI type that is a parent in a hosting rule: It cannot be a child in any containment rule.
- Hosting rules cannot create loops such as Tomcat –runs_on- VMWare –runs_on- Tomcat.

Hosting and containment rules model

[Diagram showing containment rules and hosting rules]

Hosting rules that model the diagram:
- Tomcat 'Runs on' Hardware

Containment rules that model the diagram:
- Tomcat 'Contains' Configuration File
- Tomcat 'Contains' WAR
- WAR has two endpoints for JDBC with MySQL:
  - Inbound
  - Outbound
Valid set of rules

Tomcat Hosted Linux
Linux Hosted Computer

The second metadata entry triggers the third requirement, which is satisfied (it is a hosting rule, not a containment rule).

Create dependent relationship rules

Create hosting and containment rules (dependent relationship rules) for CI classes to help with correctly identifying dependent CIs during the business discovery process and service mapping. Discovery calls the identification API that applies dependent relationship rules.

You can create a basic hosting or containment rule in the CI Class Manager. Or, use the Metadata Editor to create groups of hosting and containment rules, and inbound or outbound endpoints in containment rules. The CI Class Manager and the Metadata Editor are synchronized, and you can use each of those tools to display and edit a dependent rule.

Create a dependent relationship rule for a CMDB class

Use the CI Class Manager to create a basic dependent relationship rule (hosting or containment relationship rule) for a CMDB class.

Role required: itil has read access, itil_admin (on top of itil) has full access.

The class for which you create dependent relationship rule, must have a dependent identification rule.

1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list, and select the class for which you want to create a hosting or a containment rule.
3. In the class navigation bar, click Dependent Relationships.
4. In the Dependent Relationships view, click Add dependency.
5. Fill out the details in the Add Dependent Relationship Rule dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Type</td>
<td>Designation of whether this rule is a hosting rule or a containment rule.</td>
</tr>
<tr>
<td>This Class</td>
<td>The class that the rule applies to.</td>
</tr>
<tr>
<td>Relationship</td>
<td>The relationship type for the rule.</td>
</tr>
<tr>
<td>Target Class</td>
<td>The target class for the dependent relationship rule. The designation of this class as a child or parent class, is based on the specified Relationship.</td>
</tr>
</tbody>
</table>

6. Click Save.

You can click Reset to derived and then confirm the operation to delete all dependent relationship rules that were added specifically for the selected class. Only dependent relationships that are derived from a parent class, remain.

For more information about child and parent classes, see Table extension and classes.

Create or edit a collection of containment rules

Create containment rule for CIs to help with correctly identifying dependent CIs during the business discovery process and service mapping. Discovery calls the identification API that applies dependent relationship rules.
Role required: admin

A containment rule is a dependent relationship rule which defines a relationship between two CIs, structured as: CIType1 RelationshipType CIType2. The first CI type that you add becomes the top level CI of a containment rules group which is a chain of containment rules. The entire set of containment rules is organized as groups according to top-level CIs.

To create a containment rules group for a new CI type, you need to first add the CI Type1 of the relationship. To add a child containment rule for a CI type that exists, you need to select that CI type, and define the second portion of the relationship rule which is the relationship type and CI Type2.

To each rule within a containment rules group you can add inbound or outbound endpoints, which are noted by blue up and down arrows. After adding an endpoint, you can not add a containment rule in that branch of the containment rules hierarchy.

1. Navigate to Configuration > Metadata Editor.
2. In the Metadata Editor, click the Containment Rules tab.
3. Click Add New Rule to add a top-level rule. Or, point to a rule for which you want to add a child rule and click the green ‘+’ icon that appears on the right.
4. Complete the Add Containment Rule to <class> form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item Type</td>
<td>The CI class that the rule applies to.</td>
</tr>
<tr>
<td>Relationship Type</td>
<td>The relationship type for the rule.</td>
</tr>
<tr>
<td>Reverse Relationship Direction</td>
<td>Enable to use the reverse relationship in the rule.</td>
</tr>
<tr>
<td>Always include in Service Model</td>
<td>Enable to always include the CIs of the specified class in the Service Map if their parent CI (based on the containment relationship) is present in the Service Map.</td>
</tr>
</tbody>
</table>

5. Click Create.
6. Add an endpoint to a child rule:
   a) Point to a child rule for which you want to add an endpoint.
   b) Click the blue “+” icon that appears on the right.
   c) Complete the Add Endpoint To <class> form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint Type</td>
<td>The type of endpoint.</td>
</tr>
<tr>
<td>Inbound or Outbound</td>
<td>The direction of the endpoint.</td>
</tr>
</tbody>
</table>

d) Click Create.

Create or edit a collection of hosting rules
Create hosting rule for CIs to assist in correctly identifying dependent CIs during the business discovery process and service mapping. Discovery calls the identification API that applies dependent relationship rules.

A hosting rule is a dependent relationship rule which defines a relationship between two CIs, structured as: <CI Type1> <relationship type> <CI Type2>. To create a hosting rule, you need to add a CI type as <CI Type1> in the relationship rule, and then define the second portion of the relationship rule which is the relationship type and <CI Type2>. The entire set of hosting rules is organized as groups according to the top-level hosted CIs.
A hosting rule implicitly contains two rules, which are the reversal of each other. When you create the rule '<CI Type1> <relationship type> <CI Type2>', the rule '<CI Type2> <reversed relationship type> <CI Type1>' is automatically added.

Role required: admin

1. Navigate to Configuration > Metadata Editor.
2. In the Metadata Editor, click the Hosting Rules tab.
3. Click Add New Rule to add a top-level rule. Or, point to a rule for which you want to add a child rule and click the green '+' icon that appears on the right.
4. Complete the Add Hosted/Hosting Rule to <class> form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item Type</td>
<td>The &lt;CI Type2&gt; in the rule.</td>
</tr>
<tr>
<td>Relationship Type</td>
<td>The relationship type for the rule.</td>
</tr>
<tr>
<td>Reverse Relationship Direction</td>
<td>Check to reverse relationship in the rule.</td>
</tr>
</tbody>
</table>

5. Click Create.

Effective usage of CMDB Identification

Use CMDB Identification effectively.

Identification rules

An independent identification rule identifies a CI based on the CI's attributes, independently of other CIs.

A dependent identification rule identifies a CI by its dependent CIs and the relationships of the identified CI with those dependent CIs. Identification with a dependent identification rule is based on the dependent CIs and the relationships and qualifiers between the identified CI and its dependent CIs. Identification then requires more time than with an independent identification rule and is prone to some identification errors. Usage of dependent rules should therefore be minimized.

CI modeling determines which type of identification rules are required for proper CI identification.

Create identification rules using the following order of importance:

1. Independent identification rules — It is always preferable to create independent identification rules rather than dependent identification rules. When you model a CI, define the CI with a complete set of attributes that lend themselves to independent identification, eliminating the need to use additional CIs for identification.
2. Dependent identification rules — If it is necessary to create dependent identification rules, then define a single level of dependency. Two is the maximum number of dependency levels that is supported.
3. Avoid creating lookup identifier entries. The use of lookup identifier entry is highly discouraged as it can reduce performance. If unavoidable, ensure to first review class definitions and consider updates that allow usage of independent identification rules.
4. Limit the number of identifier entries within an identification rule, ideally to 1. A second identifier entry can further reduce performance, as will each additional identifier entry.
5. Create strong identification rules in which the strongest identifier entries and related entries are set with the highest priority.
6. Ensure that the identification rule is at the class level that it needs to be.
Payload

Create the payload using the following order of importance:

1. **Payload size** — Limit the number of CIs per payload to 500.
2. **Avoid duplicate entries in the payload.**
   
   Example: If an identification rule has a criterion attribute for the `name` field, then the following payload has duplicate items resulting in failure:

   ```javascript
   var payload = {
     items: [ {
       className:'cmdb_ci_linux_server',
       values: { 
         name:'Win Server 200',
         ram:'2048'
       }},
       { 
         className:'cmdb_ci_linux_server',
         values: { 
           name:'Win Server 200',
           ram:'4096'
         }
       ]
     ]
   };
   ```

3. **Do not pass system data such as the following in the payload.**

   ```javascript
   var payload = {
     items: [ {
       className:'cmdb_ci_linux_server',
       values: { 
         name:'Win Server 200',
         sys_domain:'global',
         sys_domain_path:'xyz',
         sys_updated_on:'2017-06-15 16:25:11',
         sys_mod_count:23,
       }
     ]
   };
   ```

4. **Provide the minimum necessary set of criterion attributes for each payload item, according to what is specified in the corresponding identification rules.**

5. **When matching CIs, use CIs’ sysIds if available.** If provided, IRE can use the sysId to directly locate a CI without requiring any criterion attributes from the identification rule. In this case, IRE does not use the sysId in the matching process.

   - Example: Independent CI that needs to be updated — sysId is available.

     ```javascript
     var payload = {
       items: [ {
           className:'cmdb_ci_linux_server',
           values: { 
           sys_id:'194876usytrr65378098',
           ram:'2048',
         }
       ]
     };
     ```

   - Example: Dependent CI that needs to be inserted. Tomcat War CI depends on Tomcat CI, and Tomcat CI depends on Linux Server CI. SysIds for the Tomcat and the Linux CIs are available.

     ```javascript
     var payload = {
       items: [ {
           className:'cmdb_ci_linux_server',
           values: { 
           sys_id:'194876usytrr65378098',
           ram:'2048',
         },
       } ]
     };
     ```
items: [{
    className: 'cmdb_ci_app_server_tomcat_war',
    values: {
        name: 'war1',
        short_description: 'my description'
    }
}, {
    className: 'cmdb_ci_app_server_tomcat',
    values: {
        sys_id: '194876usytrr65378098'
    }
}, {
    className: 'cmdb_ci_linux_server',
    values: {
        sys_id: '09876tysueyt6345laku'
    }
}],
relations: [{
    parent: 1,
    child: 0,
    type: 'Contains::Contained by', { 
        parent: 1,
        child: 2,
        type: 'Runs on::Runs'
    }
}];

- Example: Dependent CI that needs to be updated — sysId is available.

```javascript
var payload = {
    items: [{
        className: 'cmdb_ci_app_server_tomcat_war',
        values: {
            sys_id: '039387euey637465sytet',
            short_description: 'my description new'
        }
    }]
};
```

6. When inserting many CIs, all of which depend on the same CI, you should serialize your API calls. Otherwise, attempting to concurrently process many CIs can clog the system, significantly degrading overall system performance.

**Properties for Identification and Reconciliation**

Use the Identification and Reconciliation properties to configure the identification engine.

These properties are available for Identification and Reconciliation. To view and edit these properties, the admin role is required.

**Note:** To open the System Properties [sys_properties] table, enter `sys_properties.list` in the navigation filter.
## Properties for Identification and Reconciliation

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enforce the requirement that required attributes cannot be null during identification and reconciliation. glide.required.attribute.enabled | • Type: true | false  
• Default value: true  
• Location: Configuration > CMDB Properties > Identification/Reconciliation Properties |
| Allow class upgrade during IRE identification and reconciliation. glide.class.upgrade.enabled | • Type: true | false  
• Default value: true  
• Location: Configuration > CMDB Properties > Identification/Reconciliation Properties  
• Learn more: CI reclassification.  
When false, IRE rejects a payload with the respective reclassification update, and creates a reclassification task. |
| Allow class downgrades during IRE identification and reconciliation. glide.class.downgrade.enabled | • Type: true | false  
• Default value: true  
• Location: Configuration > CMDB Properties > Identification/Reconciliation Properties  
• Learn more: CI reclassification.  
When false, IRE rejects a payload with the respective reclassification update, and creates a reclassification task. |
| Allow class switching during IRE identification and reconciliation. glide.class.switch.enabled | • Type: true | false  
• Default value: true  
• Location: Configuration > CMDB Properties > Identification/Reconciliation Properties  
• Learn more: CI reclassification.  
When false, IRE rejects a payload with the respective reclassification update, and creates a reclassification task. |
| Allow the update of an empty field by a lower priority data source. glide.reconciliation.override.null | • Type: true | false  
• Default value: true  
• Location: Configuration > CMDB Properties > Identification/Reconciliation Properties |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.identification_engine.skip_duplicates</td>
<td>Controls how identification processes a small set of duplicate CIs.</td>
</tr>
<tr>
<td>glide.identification_engine.skip_duplicates.threshold</td>
<td>Maximum number of CIs that can be in a set of duplicate CIs to allow identification to process the duplicate CIs according to the setting of glide.identification_engine.skip_duplicates.</td>
</tr>
<tr>
<td>glide.identification_logs.max_run_ids</td>
<td>Maximum number of log runs that can be displayed when navigating to Configuration &gt; Identification Logs.</td>
</tr>
<tr>
<td>glide.cache.size.service_cache</td>
<td>Maximum cache size (in MB) that is used by the identification engine for inbound and outbound relations. When the limit is reached, the least recently used cached data is discarded, releasing space for new data.</td>
</tr>
</tbody>
</table>

**Note:** You cannot disable the service cache.

- Type: Integer
- Default value: 20
- Location: Add to System Properties [sys_properties] table.

- Type: true | false
- Default value: true
- Other values:
  - true
  - If the number of duplicate CIs is less than the threshold specified by glide.identification_engine.skip_duplicates.threshold, then the oldest of the duplicate CIs is picked as a match and gets updated. That oldest CI is also designated as the master CI for that set of duplicate CIs.
  - For the rest of the duplicate CIs, the duplicate_of field is set as a reference to the master CI.
  - false
  - Matching a CI fails, and an error is logged.

- Location: Configuration > CMDB Properties > Identification/Reconciliation Properties

- Type: Integer
- Default value: 5
- Location: Configuration > CMDB Properties > Identification/Reconciliation Properties

- Type: Integer
- Default value: 20
- Location: Add to System Properties [sys_properties] table.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.identification_engine.granular_insert_locking</td>
<td>Determines whether to use multiple granular insert locks or single global insert lock.</td>
</tr>
<tr>
<td></td>
<td>Set to false if there are performance issues associated with the usage of multiple granular insert locks.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to System Properties [sys_properties] table.</td>
</tr>
<tr>
<td>glide.identification_engine.batch_update_last_discovered</td>
<td>Controls batch update of last_discovered field in CIs that are being processed by the identification engine.</td>
</tr>
<tr>
<td></td>
<td>Set to false if there are business rules that apply to last_discovered field, and you want to trigger these rules when calling an Identification and Reconciliation API.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to System Properties [sys_properties] table.</td>
</tr>
<tr>
<td>glide.identification_engine.related_items_local_cache_count</td>
<td>For optimization, a custom number of locally cached query result entries of related/lookup items.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 15000</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to System Properties [sys_properties] table.</td>
</tr>
</tbody>
</table>

**Note:** If there is a memory issue due to optimization related to using local cache, set the glide.identification_engine.related_items_local_cache_count and the glide.identification_engine.dependent_items_local_cache_count properties to 0.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.identification_engine.dependent_items_local_cache_count | For optimization, a custom number of locally cached query result entries of dependent CIs.  
- Type: integer  
- Default value: 10000  
- Location: Add to System Properties [sys_properties] table. |

**Note:** If there is a memory issue due to optimization related to using local cache, set the glide.identification_engine.related_items_local_cache_count and the glide.identification_engine.dependent_items_local_cache_count properties to 0.

| glide.identification_engine.independent_items_local_cache_count | For optimization, a custom number of locally cached query result entries of independent CIs.  
- Type: integer  
- Default value: 100000  
- Location: Add to System Properties [sys_properties] table. |

Setting the value to 0 avoids using local cache for independent CIs and might affect performance.

| glide.cmdb.logger.source.identification_engine | Enable and configure what type of details the system logs when using IRE outside the scope of identification simulation. For example, when using an API, ECC queue or scheduled jobs.  
- Type: string  
- Values: info, warn, error, debug, or debugVerbose  
- Location: Add to System Properties [sys_properties] table. |

### Components installed with Identification and Reconciliation

Several types of components are installed with Identification and Reconciliation (included in the com.snc.cmdb plugin), including tables.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier [cmdb_identifier]</td>
<td>Identification rule sets defined for different classes of CIs.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reconciliation Definition</td>
<td>Reconciliation rules defined for different classes of CIs at the table and field level.</td>
</tr>
<tr>
<td>[cmdb_reconciliation_definition]</td>
<td></td>
</tr>
<tr>
<td>Identifier Entry</td>
<td>Rule entries with different priorities assigned to each identifier.</td>
</tr>
<tr>
<td>[cmdb_identifier_entry]</td>
<td></td>
</tr>
<tr>
<td>Data Source Precedence</td>
<td>Priorities of data sources that are authorized to update the same CI types or CI type with same sets of attributes.</td>
</tr>
<tr>
<td>[cmdb_datasource_precedence]</td>
<td></td>
</tr>
<tr>
<td>Duplicate Audit Result</td>
<td>Duplicate audit results corresponding to a specific duplicate task. These results are generated automatically during the identification process and should not be added manually.</td>
</tr>
<tr>
<td>[duplicate_audit_result]</td>
<td></td>
</tr>
<tr>
<td>Remediate Duplicate Task</td>
<td>Task to address duplication that is detected during the identification process. Records are generated automatically, and users should not add records manually.</td>
</tr>
<tr>
<td>[reconcile_duplicate_task]</td>
<td></td>
</tr>
<tr>
<td>Reclassification Task</td>
<td>Reclassification tasks that were generated during the identification process.</td>
</tr>
<tr>
<td>[reclassification_task]</td>
<td></td>
</tr>
<tr>
<td>Data Source History</td>
<td>Information about the last data source that updated each attribute. Used to determine if a data source can update a stale CI.</td>
</tr>
<tr>
<td>[cmdb_datasource_last_update]</td>
<td></td>
</tr>
<tr>
<td>Data Source Staleness Definition</td>
<td>Effective duration per data source. When effective duration is exceeded, then CMDB Health determines that the information provided by that data source is stale.</td>
</tr>
<tr>
<td>[cmdb_datasource_staleness]</td>
<td></td>
</tr>
<tr>
<td>Identification Engine Context</td>
<td>Input payload, and data source (cmdb_ci's discovery_source) that will be used as input for a specific identification engine API. Also information about which specific identification engine API will be called (identifyCI or createOrUpdateCI API).</td>
</tr>
<tr>
<td>[cmdb_ie_context]</td>
<td></td>
</tr>
<tr>
<td>Identification Engine Run</td>
<td>Specific cmdb_ie_context record that was used to run against the identification engine. Also details about the output payload returned by APIs, such as start and end time of the run and whether the run was successful.</td>
</tr>
<tr>
<td>[cmdb_ie_run]</td>
<td></td>
</tr>
</tbody>
</table>
Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identification Engine Log</td>
<td>Identification engine logs for a specific cmdb_ie_run simulated in the identification simulation. Also details about logs level and order.</td>
</tr>
</tbody>
</table>

Note: Internal table used by identification simulation.

CMDB Health

Monitoring and maintaining the health of the CMDB is essential to an effective and continuous use of the product. Health indicators such as duplicate CIs, required CI fields, and audits contribute to the calculation of health scorecards at the CI, class, and CMDB level.

The health of the CMDB data is monitored and reported for the following KPIs, each further consisting of sub metrics:

- **Completeness**: CIs are tested for required and recommended fields that are not populated.
- **Correctness**: CIs are tested against pre-defined data integrity rules such as identification rules (to detect duplicate CIs), orphan CI rules, and stale CI rules.
- **Compliance**: The CMDB data is audited for adherence to pre-defined certificates.
- **Relationships**: The health of CI relationships is tested for indicators such as orphan and duplicate relationships. And for compliance with suggested relationships, hosting and containment rules.

After CIs are tested for various health indicators, the results are aggregated at the class level, and eventually at the overall CMDB level. You can configure how health is calculated and the weight of each KPI and each metric at every level of the aggregation. For most health tests, you can configure the health tests themselves.

CMDB Health is domain aware. If the domain separation plugin has been activated, then the CMDB dashboard displays health based on data, rules, and settings from the logged-on user domain. If rules and settings are not defined for a child domain, then the parent’s settings are applied, recursively.

CI remediation

CMDB Health provides a framework for configuring **CI remediation**. Remediation lets you proactively apply corrective actions to unhealthy CIs in a managed and standardized fashion.

Setup

You need to configure CMDB Health related system properties, and health KPI and metric rules, to customize how aggregated data is calculated and other CMDB Health behavior. To start gathering and aggregating health data, you need to enable the CMDB Health-related jobs (CMDB Health Dashboard jobs) which are initially disabled. See **Setup and configure CMDB Health** for details about enabling these jobs and about configuring other CMDB Health settings.

Domain separation in CMDB Health

This is an overview of domain separation as it pertains to CMDB Health. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.
Overview

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

CMDB dashboards should be set up with their own set of rules to best accommodate how the user needs them. CMDB dashboard jobs adhere to those rules to produce reports. These are covered in separate sections below.

How domain separation works in CMDB Health

For dashboards to be the most effective, users should configure the dashboard accordingly. This is done by setting up the orphan, staleness, and inclusion rules to meet their needs, and which then affect the reports displayed on the dashboard.

The settings and metrics define different aspects of each application because each domain can be configured differently. These rules are set up in addition to those that are included in the base system. There are different types of owners for different CIs; each domain has its own set of rules.

Note: Domain separation is on by default, but each domain can be configured as needed.

Health Preferences

Configure these preferences during setup:

1. Global system properties that control CMDB Health – System properties are not domain separated. To learn more see CMDB Health system properties.

2. CMDB Health Dashboard Jobs – There is a dashboard job for each major KPI, such as Completeness. That job finds the health of the CIs across all the enabled domains. There is only one job run for all domains and jobs themselves are not domain separated.

   Users can define the frequency with which they want to run jobs; the report runs for all the domains. The more domains included in the job, the longer the job runs.

3. Health Metrics – These selections are domain-separated and adhere to the established “system overrides” logic of domain separation. Changes are made according to the domain for which the user is logged in. Base system values are defined at the global domain. The overriding domain logic means these values apply for all domains. If users want different values for a domain, they must be logged in to a specific domain and change the property from there. The new property setting applies only to that domain and any domain that inherits this domain. To learn more see Health Metrics.

   Note: Regarding the Completeness, Compliance, and Correctness KPIs: Users can disable this KPI if they don’t want to see that as part of the dashboard score. All these settings are domain-separated and the user can define specific properties for the domain.

   a. Weighted averages – These settings can affect all or part of the metrics in Completeness, Compliance, Correctness, and Relationship. They can be set differently for different domains.

   b. Active – This setting is the most important because it affects how long the jobs run. The more domains with flags set to Active, the longer the jobs take. It’s best to select only those domains you wish to be Active and render the rest Active = false. You can set this in Health Preferences. The default settings for global domain are set to Active = true, but you can modify or disable specific domains the user wants to see in the dashboard. Users should consider the domain hierarchy when changing these values. If there is a large number of domains (>100) the job
can take a very long time. To mitigate this, set Active to False for all the root domains, thereby disabling all the other domains in the hierarchy. If there is a rule at the top, all child domains inherit that rule.

c. Failure Threshold, Create Task, Task Assignee Group – All these settings can be set differently for different domains depending on what is needed in each domain.

d. Exceptions – For Relationship metrics (relationship, duplicate relations, orphan relations, stale relations) the failure threshold setting is not domain separated. The Failure Threshold for the global domain is applied to all domains. For example, even if users were to override the Failure Threshold for a domain, the global domain setting for Threshold is still applied.

e. Troubleshooting / Implementation detail – These settings are stored in the `cmdb_health_metric_pref` table, which is domain separated.

Health Rules

Health rules settings are addressed here:

- Required
- Recommended
- Orphan
- Staleness

Most of the CMDB Health Rules are domain separated and provided by the users. Users can define different rules for different domains by logging in to each domain and adding/overriding rules in the CI Class Manager.

These are the rules for the different metrics:

1. Completeness
   a. Required fields – These are based on the class schema defined in the platform’s `#unique_304` and is fixed for all domains. These cannot be changed.
   b. Recommended fields – These are domain separated. The table used is `cmdb_recommended_fields`, which is domain separated. The user can set these up for different domains.

2. Correctness
   a. Duplicates – Duplicates are based on Identification rules, which are not domain separated, so the same rules apply to all domains.
   b. Orphan – Orphan rules are domain separated; there are different orphan rules for different domains. The table used is `cmdb_health_orphan_rule` and is domain separated.
   c. Staleness – Staleness rules are domain separated. The table used is `cmdb_health_staleness_rule`. The base system rule (60 days) is set for global domain so is inherited by all domains as the default rule.
3. Compliance
   a. Audit – Audit scores are based on the desired state or scripted audits defined in the compliance module by the user.

   Audits themselves are domain separated. When audit score evaluation is enabled for a domain, scores become based only on the audits visible in that domain.

   **Note:** Health Inclusion Rules are also domain separated. The table used is `cmdb_health_config`, which is domain separated.

**Health Dashboards (CMDB View/ Service View / Group View)**

If a user is logged into a domain and views a health dashboard:

1. Only scores for enabled metrics in that domain display (based on the Health Preferences Active flag as discussed above).
2. All scores are based on CIs that are visible from the specific domain. (These are regular domain visibility rules: From that domain you can see CIs in global domain, the specific domain, any child domain of that domain or any domain that gets directly or indirectly contained by that domain.)
3. The dashboard view is based on domain rules defined in domain mapping, as opposed to those provided by the logged-in user. This view overrides any additional domain visibility rules that a logged-in user might have. The admin sets the basic rules, but does not set each individual domain. The admin can give specific users or user groups additional visibility to other domains and the dashboard still does not change. The dashboard strictly follows the domain rules mentioned above, based on the domain hierarchy for the domain in which the user is logged in.
4. As explained in the Health Preferences section, users can define different preference values for any domain which impact the scores reported in the dashboard. Preferences that can impact scores include Weighted Averages, Failure Threshold, and Active.
5. As explained in the CMDB Health Rules section, the scores reported for the metrics are based on the health rules defined for them (staleness, orphan, recommended, audit, and inclusion rules) which can be defined differently for a specific domain (in the CI Class Manager). Only the required metric and duplicate metric are based on rules that apply in all domains.
6. Service View/ Group View – These reports also largely follow the above points. Typically, these views differ from various views/filters for the Health Report. One is based off business rules, the other is based off CMDB Health groups.

**Setup and configure CMDB Health**

The data collection system is highly configurable, however, the base system is minimally configured for aggregating CMDB health data. Most importantly, the CMDB Health Dashboard jobs are disabled by default and data is not collected. To display valuable and meaningful data, you should review and adjust settings.

1. Review CMDB Health KPIs and metrics to learn what CMDB Health can monitor, and what needs to be configured to enable and support each metric.
2. For each KPI and associated metric that you want monitored, define the necessary rules and fulfill other needed requirements. For example, create orphan rules for detecting orphan records, if you are interested in this metric.
3. Review and adjust the threshold ranges for best, at risk, and critical states for the CMDB health metrics scorecards - see Configure CMDB Health scorecard thresholds.

4. Set metric aggregation preferences, deactivate KPI and metrics that you are not interested in reporting, set failure thresholds, and adjust weighted averages of aggregation - see Configure KPI and metrics aggregation preferences.

5. Narrow the scope of CIs that are included in health calculations - see Create health inclusion rule.

6. Enable the Health Dashboard jobs for the KPIs that you want reported - see Enable and configure a CMDB Health Dashboard job.

7. Customize the CI dashboard (optional).

**CMDB Health system properties**

Configure the following system properties to customize how CMDB Health is monitored and evaluated.

Role required: itil_admin

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Max time in minutes for which individual metric processor will run in each scheduled cycle [glide.cmdb.health.metricProcessor.maxRunningTime] | If processing of a metric exceeds the specified time, CMDB Health processing halts until the next CMDB Health job is scheduled to run.  
  - Type: integer  
  - Default value: 120  
  - Location: Navigate to Configuration > Health Preference. In the right hand-side navigator, click System Properties.  
  For performance reasons, it is recommended not to set this property to a value greater than 120.  
  | Note: If you enter an invalid value, the default value is used. |

*Note: To open the System Property [sys_properties] table, enter sys_properties.list in the navigation filter.*
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.cmdb.logger.use_syslog.CMDBHealth | A comma-separated list that controls the level of logging of CMDB Health jobs. Logging creates entries in the system logs to capture messages generated by the health auditing process each time they run. This logging helps debugging if there is a failure. For example, to log error and info messages, set the value to ‘error,info’.  
  - Type: String  
  - Default value: error  
  - Other possible values: Comma-separated list with any of the following values:  
    - info  
    - error  
    - warn  
  Or ‘*’ which is equivalent to including all possible values.  
  - Location: System Property [sys_properties] table. |
| glide.cmdb.health.src.cmdb_health_audit_only | When set to true, disables health results from sources other than CMDB Health audit (such as cloud discovery). Only results generated by CMDB Health audit appear in the CMDB dashboard.  
For example, by default, if a CI is determined to be stale by Discovery, then that CI appears as stale in the CMDB dashboard even though CMDB Health audit did not determine that CI to be stale. To disable these stale CI health results, set the property to true.  
  - Type: true | false  
  - Default value: false  
  - Location: System Property [sys_properties] table.  
  - Learn more:  
    - CMDB Health KPIs and metrics  
    - Discovery for VMware vCenter |
| glide.cmdb.health.staleness_exclude_dependent_cis | Exclude dependent CIs for the staleness CMDB Health metric.  
When enabled, dependent CIs are not checked for staleness, regardless of any staleness or inclusion rules that are defined for the respective CI types.  
  - Type: true | false  
  - Default value: false  
  - Location: System Property [sys_properties] table. |
Enable and configure a CMDB Health Dashboard job

Enable and configure the jobs that process CMDB health tests, to start calculating CMDB health scores for the **completeness, compliance, correctness, and relationship** KPI. These health scores are then aggregated into the overall CMDB health report.

**Role required:** admin

In the base system, CMDB Health Dashboard jobs are disabled by default. Enable and configure the respective job for the CMDB health KPI that you want data collected and aggregated for. You can schedule a job to run on a recurring schedule, or execute it once at any time.

1. Navigate to **Configuration > CMDB Dashboard > CMDB View**, and then click **CMDB Health Dashboard Jobs**.
2. Select a job that you want to enable or configure.

<table>
<thead>
<tr>
<th>CMDB Health Dashboard job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Health Dashboard - Completeness Score Calculation</td>
<td>Script for calculating the completeness KPI of CMDB health.</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Compliance Score Calculation</td>
<td>Script for calculating the compliance KPI of CMDB health.</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Correctness Score Calculation</td>
<td>Script for calculating the correctness KPI of CMDB health.</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Relationship Score Calculation</td>
<td>Script for calculating the CI relationships KPI of CMDB health.</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Relationship Compliance Processor</td>
<td>Script for calculating compliance of relationships with suggested relationships, and with hosting and containment rules.</td>
</tr>
</tbody>
</table>

3. Review the default configuration, and update as necessary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Job name. It is recommended that you do not modify the job's name.</td>
</tr>
<tr>
<td>Active</td>
<td>Select to activate the job.</td>
</tr>
<tr>
<td>Run</td>
<td>Configure recurring schedule of job execution, or select <strong>On Demand</strong>.</td>
</tr>
<tr>
<td>Time</td>
<td>If <strong>Active</strong> is selected, set the time (hour, minute, and second) to run the job.</td>
</tr>
<tr>
<td>Conditional</td>
<td>If selected, the scripted condition must evaluate to true before the job can run.</td>
</tr>
<tr>
<td>Run this script</td>
<td>The job's script. Modifications to the script are not recommended.</td>
</tr>
</tbody>
</table>

4. Click **Execute Now** to run the job once immediately.

After you enable a CMDB Health Dashboard job, the results for the KPI are aggregated and displayed in the CMDB dashboard and CI dashboard, at the CMDB, class, and CI levels.

**Configure CMDB Health scorecard thresholds**

Configure the thresholds for best, at risk, and critical state definitions for the KPIs and metrics scorecards. You can configure these settings globally for the entire CMDB, or individually per class.
Role required: itil has read access, itil_admin (on top of itil) has full access.

Scorecard thresholds are used to determine overall metric state, and are defined by upper and lower thresholds. For example, scorecards thresholds for completeness:

- 0 - lower threshold: Best state
- Lower threshold - upper threshold: At risk state
- Upper threshold - 100: Critical state

In the base system, upper thresholds are set to 67 and lower thresholds are set to 33 for all KPIs and metrics. You can adjust scorecard thresholds to reflect the range of failures that should be used for each health state. Applying the change to a scorecard is based on the selected class in the CI Classes list:

- If the top level Configuration Item class is selected in the CI Classes list, changes to metric scorecards apply to the entire hierarchy.
- If any other class is selected in the CI Classes list, changes to metric scorecards apply to the selected class.

For CMDB groups, you can specify a separate set of scorecard thresholds, per CMDB group/KPI or metric. See Configure CMDB groups scorecard thresholds for more details.

1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list, and then select a class to set scorecards for.
3. In the class navigation bar, expand Health.
4. To configure the overall scorecard, select Other Scorecards and then select Overall Scorecard.
5. To configure a scorecard for any of the KPIs (such as Compliance), or for relationship-related metrics (such as duplicate relations):
   a) Select configuration item at the top of the Hierarchy list.
   b) Click a KPI item, Completeness, Compliance, or Correctness.
   c) Click the tab CMDB Completeness Scorecard, CMDB Compliance Scorecard, or CMDB Correctness Scorecard.

When you select the top-level Configuration Item class, changes to threshold settings in any metric scorecard apply to the entire class hierarchy.

6. To configure a scorecard for any metric:
   a) In the CI Classes list, select the class to which the updated scorecard should apply to. Select the top level Configuration Item to apply the change to the entire hierarchy.
   b) Click the KPI that contains the metric for which you want to configure scorecard. For example, click Completeness to configure the Required Fields scorecard.
   c) Select the scorecard tab of the metric to configure, such as Required Fields Scorecard. You might need to click New to edit the scorecards.

7. Slide the threshold sliders, or enter specific numbers to increase or to decrease the threshold bars to fit your definitions for best, at risk, and critical levels for the scorecard.
8. Click Save.

Configure CMDB groups scorecard thresholds

Each CMDB group can have its unique set of scorecard thresholds for best, at risk, and critical state definitions for specific KPIs or metrics.

Role required: itil_admin (on top of itil)

Scorecard thresholds are used to determine overall metric state, and are defined by upper and lower thresholds:
• 0 - lower threshold: Best state
• Lower threshold - upper threshold: At risk state
• Upper threshold - 100: Critical state

In the base system, for all KPIs and metrics, upper thresholds are set to 67 and lower thresholds are set to 33. You can adjust scorecard thresholds for a specific CMDB group per KPI or metric, to reflect the range of failures that should be used in health reporting.

CMDB groups scorecard thresholds are stored in the [cmdb_health_scorecard_group_threshold] table.

1. In the search box in the navigation bar, enter `cmdb_health_scorecard_group_threshold.list` and press the Enter key.
2. In the **CMDB Health Group Scorecard Thresholds** list, click **New**.
3. Fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upper threshold</td>
<td>Upper range of percentage of CIs failing the specified metric tests, that is used to calculate best and at risk states.</td>
</tr>
<tr>
<td>CMDB Group</td>
<td>The CMDB group to which this scorecard threshold setting applies to.</td>
</tr>
<tr>
<td>Lower threshold</td>
<td>Lower range of percentage of CIs failing the specified metric tests, that is used to calculate at risk and critical states.</td>
</tr>
<tr>
<td>Metric</td>
<td>The metric to which the scorecard threshold setting applies to.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Configure KPI and metrics aggregation preferences**

Metrics health scorecards are aggregated into their respective KPI, which in return are aggregated into the overall CMDB Health report. Set aggregation preferences for KPIs, and for each of their respective metrics, deactivate KPIs and metrics that you are not interested in reporting, and adjust weighted averages of aggregation.

To start collecting and reporting CMDB health KPIs and metrics, you must first enable and configure the **CMDB health dashboard jobs**.

Role required: itil_admin (on top of itil)

The completeness KPI for example, consists of the metrics **required fields** and **recommended fields**, each contributing a different weight to the sum. You can configure the proportional weight of required fields and recommended fields within completeness to be 25 and 75 respectively. You can also configure the proportional weight of completeness, compliance and correctness within the aggregated sum of the overall CMDB health.

**Note:** Non-active KPI or metrics are displayed on the CMDB dashboard in faded coloring, displaying the most recent aggregations that were calculated when the KPI or metric was active.

If Domain Support - Domain Extensions is activated, then you can configure aggregation preferences per domain.

In the ServiceNow base system, the weights of KPIs have default settings, and metrics are globally set.

1. Navigate to **Configuration > Health Preferences**.
2. Select **Health Metrics** on the right-hand side navigator.
3. From the **Select Metric** list select one of the KPIs such as **Completeness**, or a metric.

For **Completeness, Compliance** and **Correctness**:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Activate the KPI so it is included in the aggregated CMDB health report.</td>
</tr>
<tr>
<td>Weighted Averages</td>
<td>Specify the weight of each metric in the aggregated KPI health report. The sum of weighted averages of all metrics should be 100.</td>
</tr>
</tbody>
</table>

For a metric:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Activate the metric so it is included in the aggregated health report for the respective KPI.</td>
</tr>
<tr>
<td>Create Task</td>
<td>If a record fails the metric test, create a task with details about the failure. You can then view the task on the CI dashboard, and configure remediation for the task.</td>
</tr>
<tr>
<td>Failure Threshold</td>
<td>When the threshold number of CIs that fail the health metric test is reached, health processing stops for the metric for this cycle.</td>
</tr>
<tr>
<td>Task Assignee Group</td>
<td>An assignment group for the task.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**Set a CI attribute to be mandatory**

Configure a CI attribute as mandatory so it is included in the CMDB Health tests for the **required** metric if enabled. **Required** is a metric of the CMDB Health **completeness** KPI.

Role required: itil_admin

When a field is configured as mandatory, then if the **required** metric is enabled, the CMDB health tests check whether that field is populated or not. The CMDB dashboard displays the aggregated report of the percentage of CIs for which one or more required fields is empty.

1. Navigate to **Configuration > CI Class Manager**.
2. Click **Hierarchy** to display the CI Classes list. Then select the class with the field that needs to be set as mandatory.
3. In the class navigation bar, expand **Class Info** and then select **Attributes**. In the Attributes view, click **Added**.
4. Locate the attribute that you want to set as mandatory, and then double-click its **Mandatory** value and set it to true.

The next time the form is opened, a field status indicator appears next to the field label, indicating that a value is mandatory.

**Note:** Mandatory fields are global. The field is marked as mandatory everywhere it appears on a form.
Set a CI field to be recommended

Define a list of CI fields as recommended, noting that it is desirable that they are populated by a data source such as Discovery. You can then configure the CMDB completeness KPI to include recommended fields in its aggregated health reports.

Role required: itil has read access, itil_admin (on top of itil) has full access.

Use this for fields which should not be mandatory, but that might have useful information that the CI should have. For example, a field with information that might at some point help with diagnosis. Initially, a derived class is set with the recommended fields that are defined at the parent level. You can add or remove recommended fields for a derived class, setting it with its own recommended fields, without affecting the recommended fields at the parent or sibling levels. If all recommended fields for a derived class are removed, then the derived class automatically derives the recommended fields from its parent class.

For more information about child and parent classes, see Table extension and classes.

1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list. Then select the class that contains the fields that need to be set as recommended.
3. In the class navigation bar, expand Health and click Completeness. Then click Recommended Fields.
4. In the Recommended Fields tab, use the slushbucket to move the fields that you want to designate as recommended, from the Available list to the Selected list.
5. Click Save.

Create or edit a CMDB Health orphan rule

Create an orphan rule to determine the percentage of orphan CIs in the CMDB. This sum is then aggregated into the correctness CMDB Health KPI, and weighed into the overall CMDB health report. Orphan rules are defined per class, and only a single orphan rule can be defined per class.

Role required: itil has read access, itil_admin (on top of itil) has full access.

Specify the conditions that CIs must meet to be considered an orphan CI. Specify attributes that a CI must have, relationships that a CI should not have, or both. In the relationship conditions, you can either specify that the CI has no relationships, or a set of specific relationships that the CI doesn't have.

Note: If there is a health inclusion rule for the orphan metric, then the conditions in the health inclusion rule and the conditions in the health orphan rule, shouldn't be identical.

A health orphan rule can for example, identify a CI of the cmdb_ci_computer class as an orphan CI if the CI is not set with an owner or an asset.

1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list. Select the class for which to create an orphan rule.
3. In the class navigation bar, expand Health. Click Correctness and then click Orphan Rule.
4. Select a rule to edit if one exists, or click New. Fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>The class for which the orphan rule applies.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Attribute conditions that a CI must satisfy to be considered an orphan CI. For example, the filter conditions in which both the Assigned to and the Owned by fields are empty, will identify the matching CIs as orphans.</td>
</tr>
</tbody>
</table>
Create or edit a CMDB Health staleness rule

If the staleness metric is in effect, then staleness rules are used to determine the percentage of stale CIs in the CMDB. This sum is then aggregated into the correctness KPI, and weighs into the overall CMDB health calculation. Staleness rules are defined per class.

Role required: itil has read access, itil_admin (on top of itil) has full access.

The Discovery setting of certain types of CIs as stale takes precedence over a CMDB Health staleness rule defined for the CI. For more information about Discovery marking CIs as stale, see Discovery for VMware vCenter.

1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list. Select the class for which to create a staleness rule.
3. In the class navigation bar, expand Health and then click Correctness. Click Staleness Rule.
4. Select a staleness rule to edit or click New, and then fill out the Staleness Rule form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>And/Or operation between the Attributes conditions and the Relationship conditions.</td>
</tr>
<tr>
<td>Relationship</td>
<td>The relationship conditions that a CI must fail in order to be considered an orphan CI. To specify that a CI must have no relationships, choose Any Relation and Any Class respectively.</td>
</tr>
</tbody>
</table>

5. Click Submit or Update to save the rule.

Create health inclusion rule

Filter the CIs that are included in health calculations and that appear in CMDB health dashboards by defining health inclusion rules. Health inclusion rules can be specified per domain.

Role required: itil has read access, itil_admin (on top of itil) has full access.

Evaluation for the required, orphan, recommended, duplicate and staleness health metrics, will apply only to CIs that satisfy health inclusion rules. For example, if you want scores of the duplicate metric to appear only for server and network CIs.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies to</td>
<td>The class for which the rule applies.</td>
</tr>
<tr>
<td>Effective Duration</td>
<td>The time period that is used for the staleness test.</td>
</tr>
<tr>
<td></td>
<td>If the CI was not updated (based on Updated sys_updated_on) within the specified time period — the CI is determined to be stale.</td>
</tr>
<tr>
<td></td>
<td>If you enter a value with a prefix that is valid and a suffix that is not, such as 15 x — the valid portion of the value is used (‘15’). If the entire value is invalid — the value is ignored and the previous valid value is used.</td>
</tr>
</tbody>
</table>

5. Click Submit or Update to save the rule.
• Creating health inclusion rules at the level of the base cmdb_ci table can potentially filter out health results of all classes in CMDB health dashboards.
• Applying a health inclusion rule to the duplicate metric, is supported only in the global domain.

In addition to any health inclusion rules, identification inclusion rules also indirectly impact what appears in CMDB health dashboards for duplicate CIs. The dashboard itself uses the identification engine (IRE) to identify duplicate CIs and therefore identification inclusion rules are applied.

Inheritance of health inclusion rules:
• If there are no health inclusion rules specified for a child class, then rules specified on a parent class are applied to the child class.
• If health inclusion rules are specified for a child class, then those rules take precedence over rules specified on a parent class.

In the base system, there are no predefined health inclusion rules, in which case all CIs are included in the CMDB Health calculations.

1. Navigate to Configuration > CI Class Manager.
2. Click Hierarchy to display the CI Classes list. Select the class for which to create a health inclusion rule.
3. In the class navigation bar, expand Health and then click Health Inclusion Rules.
4. Click an existing rule to edit or click New and then fill out the Health Inclusion Rules form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies to</td>
<td>Class this rules applies to.</td>
</tr>
<tr>
<td>Active record condition</td>
<td>Criteria that CIs must meet to be included in the evaluation for the specified health metrics.</td>
</tr>
<tr>
<td>Applies to metric</td>
<td>Metrics that the rule applies to.</td>
</tr>
</tbody>
</table>

5. Click Save or Update.

CMDB Health KPIs and metrics

The overall CMDB health score consists of three Key Performance Indicators (KPIs) which are correctness, compliance and completeness, each further consisting of sub-metrics. Each KPI and metric is associated with a scorecard that determines its contribution to the aggregated health at the overall CMDB level, class, and CI level.

You can configure which KPIs and metrics are included in the aggregated calculation, and set their weight in the aggregation. In the base system, all KPIs and all metrics are included in the aggregated health report.

Overall

An aggregation of all three KPIs (correctness, completeness and compliance), according to their overall scorecard weight settings.
Correctness

A KPI which is an aggregation of the following metrics, according to the correctness scorecard weight settings.

Orphan

Measures the percentage of orphan CIs in the CMDB. A CI can become orphan if it was unintentionally left in the CMDB when it is no longer needed. A CI is determined to be orphan if:

- The CI satisfies the criteria in an orphan rule. This criteria checks for specific attributes that a CI must have, and for CIs that have no relationships or that don't have specific relationships.
- Data is missing for the CI in its respective table, or in one of its parents’ table.

Staleness

Measures the percentage of stale CIs in the CMDB. A CI is stale if it was not updated within the Effective Duration time period that is specified in the staleness rule that applies to the class.

The base system includes a default staleness rule for the Configuration Item [cmdb_ci] class, which sets the Effective Duration time to 60 days. This rule applies to all extended CMDB classes, and can be overridden by class specific staleness rules defined by the user. To determine CI staleness, a staleness rule for the CI’s class is used if it exists, otherwise, the default staleness rule is used.

In addition, a relationship in which a stale CI is a parent or a child, is determined to be a stale relationship.

Note: Discovery marks VMware vCenter CIs that no longer physically exist, as stale. By default, this setting takes precedence over a CMDB Health staleness rule defined for the CI. When drilling-down in the CMDB dashboard to Health Results, the Source for CIs determined to be stale by Discovery, is CLOUD_DISCOVERY. Setting the glide.cmdb.health.src.cmdb_health_audit_only system property to true, ensures that the CMDB dashboard displays health results generated only by CMDB Health. For more information, see CMDB Health system properties and Discovery for VMware vCenter.

Duplicate

Measures the percentage of duplicate CIs in the CMDB using identification rules. Only independent CIs are evaluated for duplication. In a set of duplicate CIs, the count of duplicate CIs is the total number of CIs in the set, minus one. The detailed graphs for a duplicate set of CIs display all the CIs in the set.

Completeness

A KPI which is an aggregation of the following metrics, according to the completeness scorecard weight settings.

Required

Measures the percentage of CIs in which fields that are defined as mandatory, are not populated. Missing fields are tagged as incomplete noting that for this CI some information is missing. Required fields are equivalent to the fields that are specified as mandatory in the system dictionary.

Recommended

Measures the percentage of CIs in which fields that are set as recommended, are not populated. Out-of-box, no recommended fields are specified.

You can use the Add Identifier Fields In Recommended Rules scheduled job to set criterion attributes from active identification rules, as recommended fields. You can use the Remove Identifier Fields In
Recommended Rules scheduled job to unset criterion attributes from active identification rules, as recommended fields.

Compliance

Based on the results of actual CMDB audit runs.

Audit

Audit compares actual values of specified fields, against expected values defined in template and scripted audits. Based on the Last run date of audits, CMDB Health identifies the set of the most recent complete audit run, and uses those audit results. To pass the CMDB Health audit test, a CI must be in compliance with all audits for that CI. Create a compliance-type audit, for which the results are calculated into the CMDB Health compliance KPI.

Relationships

Measures the health of CI relationships, consisting of the following metrics which are not-configurable:

Duplicate relationships

Relationships that have identical parent and child CIs, identical relationship type, and an identical port. Duplicate relationships are displayed per relationship type. In a set of duplicate relationships, the duplicate relationship count is the total number of duplicate relationships in the set, minus one. The detailed graphs for a duplicate set of relationships display all the relationships in the set.

Orphan relationships

A relationship that is missing either a parent CI, a child CI, or both.

Stale relationships

A relationship in which the parent CI or the child CI is a stale CI.

A single relationship can fail more than one health test. For example, a duplicate relationship can also be stale.

Also reports the following relationship-related summaries:

- Relations not compliant with suggested relations
- Relations not compliant with containment rules
- Relations not compliant with hosting rules

CMDB Health dashboards

CMDB dashboards display CMDB health reports and let you configure the CMDB health KPIs and metrics that CIs are evaluated for.
<table>
<thead>
<tr>
<th>Dashboard</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CMDB Dashboard</strong></td>
<td><strong>Configuration &gt; CMDB Dashboard &gt; CMDB View</strong></td>
</tr>
<tr>
<td>Main CMDB health dashboard:</td>
<td>• Overall CMDB and class level aggregated CI health. Aggregation is displayed from the metric level up to the overall CMDB level.</td>
</tr>
<tr>
<td></td>
<td>• Aggregated health for CI relationships, and its metrics.</td>
</tr>
<tr>
<td></td>
<td>• Displays the tasks that were generated for CIs that failed a health test.</td>
</tr>
<tr>
<td></td>
<td>• Drill down for each KPI to a detailed report of associated metrics, broken by class.</td>
</tr>
<tr>
<td></td>
<td>• Manage the CMDB Health Dashboard jobs.</td>
</tr>
<tr>
<td><strong>CI Dashboard</strong></td>
<td><strong>&lt;CI form&gt; &gt; Dashboard</strong></td>
</tr>
<tr>
<td>Health reports at the CI level:</td>
<td>• Pass/fail results for each metric, per CI.</td>
</tr>
<tr>
<td></td>
<td>• Displays incidents, changes, and other tasks affecting the CI, and business services affected by the CI.</td>
</tr>
<tr>
<td><strong>CI Class Manager</strong></td>
<td><strong>Configuration &gt; CI Class Manager</strong></td>
</tr>
<tr>
<td>Central location to manage CI classes and to configure CMDB health settings:</td>
<td>• Configure scorecard thresholds of all KPIs and associated metrics.</td>
</tr>
<tr>
<td></td>
<td>• Configure weight of KPIs and associated metrics in health aggregation.</td>
</tr>
<tr>
<td></td>
<td>• Manage rules and definitions that are used for health tests, such as orphan rules, audit certificates, and recommended fields rule.</td>
</tr>
<tr>
<td></td>
<td>• Explore the class hierarchy.</td>
</tr>
<tr>
<td></td>
<td>• Update and extend a CI class.</td>
</tr>
<tr>
<td></td>
<td>• Delete all records for a class.</td>
</tr>
<tr>
<td><strong>CMDB Health Preferences</strong></td>
<td><strong>Configuration &gt; Health Preferences</strong></td>
</tr>
<tr>
<td>Central location for configuring CMDB Health settings:</td>
<td>• Configure CMDB Health preferences.</td>
</tr>
<tr>
<td></td>
<td>• Manage the CMDB Health Dashboard jobs.</td>
</tr>
<tr>
<td></td>
<td>• Activate and configure weighted averages for KPIs and metrics.</td>
</tr>
<tr>
<td></td>
<td>• Set the maximum failure threshold for the KPIs.</td>
</tr>
<tr>
<td></td>
<td>• Configure creation of tasks for failed CIs.</td>
</tr>
</tbody>
</table>
**Dashboard** | **Use**
--- | ---
CMDB Service Dashboard  
*Configuration > CMDB Dashboard > Service View* | Main CMDB service health dashboard:
- Overall service aggregated health and detailed health for CIs per service. Aggregation is displayed from the metric level up to the overall services level.
- Displays the tasks that were generated for CIs in a service that failed a health test.
- Drill down for each KPI to a detailed report of associated metrics, broken by class.
- Manage the CMDB Health Dashboard jobs.

CMDB Group View Dashboard  
*Configuration > CMDB Dashboard > Group View* | Main CMDB groups (whose type is Health) dashboard:
- Overall CMDB health groups aggregated health and detailed health for CIs in the group. Aggregation is displayed from the CI level up to the overall group level.
- Drill down for each KPI to a detailed report of associated metrics, broken by class.
- Manage the CMDB Health Dashboard jobs.

---

**View CMDB health reports**

The CMDB dashboard serves as a central location to view aggregated health reports for your CMDB at a glance which helps you understand the CMDB health status. Also, it provides functions to address health issues, and improve CMDB health.

The CMDB dashboard requires some configuration before it can display meaningful data. Once CMDB Health is configured and the CMDB Health Dashboard Jobs are enabled, the dashboard displays data that is automatically collected and calculated on a recurring schedule. The CMDB dashboard uses the Performance Analytics framework for dashboards and employs some of the capabilities it provides. The CMDB dashboard is domain aware.

Using the CMDB dashboard requires the asset or itil role, and if the system property `glide.cms.enable.responsive_grid_layout` exists, then its value must be true. For more information, see [Enable responsive dashboards](#).

For information about sharing a responsive dashboard ([Sharing](#)), see [Share a responsive dashboard](#).

**Note:** Only users with the itil role can view a CMDB dashboard which has been shared.

Access the CMDB dashboard by navigating to *Configuration > CMDB Dashboard > CMDB View*. On the CMDB dashboard:

- Click **CMDB Health Dashboard Jobs** to enable and manage the jobs that monitor and collect health data for CIs and CI relationships.
- Click the default **CMDB Dashboard - CMDB View** dashboard to list additional CMDB drill-in dashboards.

The CMDB dashboard has two viewing modes. Click **CI Health** or **Relationship Health** to toggle between them.
CMDB Health view

The CMDB Health view is the default view for the CMDB dashboard. It contains scorecards detailing the overall health of CIs in your CMDB, per health KPI and metric. Also, it contains useful reports showing a breakdown of any duplicate, orphan or stale CIs by class, and lists the top 10 incident, alert, and change generating CIs in the CMDB.

All the default widgets in the CI Class view can be filtered using the CMDB class hierarchy tree. Initially, the class hierarchy filter is set to the root class, Configuration Item (All). Click All to select a different class, filtering all widgets on the dashboard to display data only for the selected class and its child classes.

In each scorecard widget, the horizontal bar in the center and the % number are correlated, displaying the aggregated health summary for the KPI. Health results of associated metrics are displayed underneath, each contributing according to the configuration of the metric scorecard, and its threshold.

Except for the Overall health scorecard, you can drill into any widget in the CI Class view:

- In a scorecard widget: Click the large aggregated percent number or the health bar to drill into a more detailed dashboard for that KPI.
- In a charts widget: Click a bar to display a list of all the records that the bar represents.
- In lists: Click the ‘i’ icon to view a list of all the tasks or alerts related to the CI.

Relationship Health view

The Relationship Health view displays various scorecards for health indicators of CI relationships in your CMDB. It contains charts detailing any duplicate, orphan or stale relationships, broken down by relationship type. You can drill down these charts for further details.

Changing the CI Class selection while in the Relationship view has no effect on the data displayed in this view.

Color codes

Both, the CI class view and the relationship view, use color codes when displaying aggregated health status. The status definitions are based on each scorecard’s threshold limits that are defined in the CI Class Manager.

<table>
<thead>
<tr>
<th>Color code</th>
<th>Definition</th>
<th>Default threshold setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Best</td>
<td>Less than or equal to 33</td>
</tr>
<tr>
<td>Orange</td>
<td>At risk</td>
<td>More than 33 and less than or equal to 67</td>
</tr>
<tr>
<td>Red</td>
<td>Critical</td>
<td>More than 67</td>
</tr>
<tr>
<td>Gray</td>
<td>Incomplete</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Note: The icon is a notation that the maximum failure threshold for the scorecard has been reached. The tests for the metric are halted for this cycle, and all associated aggregated summaries are 0%. Review the scorecard rules which might be ineffective, or the CMDB might be in an unstable state.
Dashboard layout configuration

The CMDB dashboard uses some of the capabilities that Performance Analytics provides for responsive dashboards. You can, for example, add or remove widgets from the layout.

For information about adding a widget (Add Widgets) and changing other layout settings such as adding a tab (Create Tab) to the dashboard, see Edit a dashboard. The drop-down that appears when adding a widget, includes CMDB-related widgets that are used in CMDB dashboards and other system widgets which are typically not relevant in CMDB reports.

Domain separation

If the Domain Support — Domain Extensions Installer plugin is activated, then the CMDB dashboard is domain aware:

- The CMDB dashboard aggregates and reports health failures and scores based on user’s domain visibility of CIs. If domain visibility lets a user see a CI, then the audit rule in that user’s domain applies to that CI, whether the CI is in the user’s domain or in a contained domain. If a CI fails health tests from different user domains, then separate failure records are created.
- Users can configure KPI and metric settings specific to the needs in their domain. So different domains can have different settings such as active/inactive, and thresholds.
- A child domain derives its immediate parent's domain health configurations if the child domain does not configure its own. A child domain can override parent's configurations by modifying them.

View services health reports

The CMDB service dashboard serves as a central location to view aggregated health reports for services at a glance. Also, it lets you drill into a service to perform remediation actions that address health issues, and that improve CMDB health. The CMDB service dashboard uses the Performance Analytics framework for dashboards and employs the capabilities it provides.

Requirements

- The Event Management and Service Mapping Core plugin must be activated.
- If the system property glide.cms.enable.responsive_grid_layout exists, then it needs to be set to true. For more information, see Enable responsive dashboards.
- Role required: asset or itil

Configuration

The CMDB service dashboard requires some configuration before it can display meaningful data, using the same settings as the CMDB dashboard. The CMDB service dashboard uses the settings for the Business Service, Manual Service, and Technical Service classes. For each CI that is included in a service, the rule settings of its respective class are applied. You can customize these settings in the CI Class Manager, and on the CMDB Health Preferences page. Once CMDB Health is configured and the CMDB Health Dashboard Jobs are enabled, the CMDB service dashboard displays data that is automatically collected and calculated on a recurring schedule.

CMDB Health is domain aware. If domain separation has been activated, then the CMDB service dashboard displays health based on data, rules, and settings from the logged-on user domain. If rules and settings are not defined for a child domain, then the parent’s settings are applied, recursively.
Access

Access the CMDB service dashboard by navigating to Configuration > CMDB Dashboard > Service View.

Report details

The CMDB service dashboard displays aggregated health for services, and also details for individual services. For a specific service, the CMDB service dashboard displays aggregated health for all the CIs in that service, including the service CI itself. Also it provides useful reports about service classes such as the Business Service class. You can drill down those reports to display further details of duplicate, orphan, or stale CIs per service and lists of the top 10 incident, alert, and change generating CIs in the service.

All default widgets can be filtered using the CMDB service hierarchy tree. Initially, the service hierarchy filter is set to Business Service. Click Business Service to expand it and to select a different class, filtering all widgets on the dashboard to display data only for the selected class, its child classes, or services of that class.

In each scorecard widget, the horizontal bar in the center and the % number are correlated, displaying the aggregated health summary for the KPI. Health results of associated metrics are displayed underneath, each contributing according to the weight configuration of the metric scorecard, and its threshold.

With the exception of the Overall health scorecard, you can drill into any widget in the service dashboard:

- In a scorecard widget: Click the large aggregated percent number or the health bar to drill into a more detailed dashboard for that KPI.
- In a charts widget: Click a bar to display a list of all the records that the bar represents.
- In lists: Click the ‘i’ icon to view a list of all the tasks or alerts related to the CI.

Color codes

The CMDB service dashboard uses color codes when displaying aggregated health status. The status definitions are based on the threshold limits for each scorecard, defined in the CI Class Manager.

<table>
<thead>
<tr>
<th>Color code</th>
<th>Definition</th>
<th>Default threshold setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Best</td>
<td>Less than or equal to 33</td>
</tr>
<tr>
<td>Orange</td>
<td>At risk</td>
<td>More than 33 and less than or equal to 67</td>
</tr>
<tr>
<td>Red</td>
<td>Critical</td>
<td>More than 67</td>
</tr>
<tr>
<td>Gray</td>
<td>Incomplete</td>
<td>N/A</td>
</tr>
</tbody>
</table>


The icon is a notation that the maximum failure threshold for the scorecard has been reached. The tests for the metric are halted for this cycle, and all associated aggregated summaries display 0%.

View CMDB groups health reports

The CMDB group view dashboard serves as a central location to view aggregated health reports for CMDB groups at a glance. Also, it lets you drill into a CMDB group to perform remediation actions that address
health issues, and that improve CMDB health. The CMDB group view dashboard uses the Performance Analytics framework for dashboards and employs the capabilities it provides.

Configuration

The CMDB group view dashboard requires some configuration before it can display meaningful data, using the same settings as the CMDB dashboard. For each CI that is included in a CMDB group, the rule settings of its respective class are applied. You can customize these settings in the CI Class Manager, and on the CMDB Health Preferences page. Once CMDB Health is configured and the CMDB Health Dashboard Jobs are enabled, the CMDB group view dashboard displays data that is automatically collected and calculated on a recurring schedule.

If the system property `glide.cms.enable.responsive_grid_layout` exists, then it needs to be set to true. For more information, see Enable responsive dashboards.

CMDB Health is domain aware. If domain separation has been activated, then the CMDB group view dashboard displays health based on data, rules, and settings from the logged-on user domain. If rules and settings are not defined for a child domain, then the parent’s settings are applied, recursively.

Role required: asset or itil

Access

Access the CMDB group view dashboard by navigating to Configuration > CMDB Dashboard > Group View. Then, select a CMDB group from the CMDB Health Group List drop-down list.

Report details

For each CMDB group, the CMDB group view dashboard displays aggregated health for all the CIs in that group. You can drill down those reports to display further details of duplicate, orphan, or stale CIs per CMDB group. In each scorecard widget, the horizontal bar in the center and the % number are correlated, displaying the aggregated health summary for the KPI. Health results of associated metrics are displayed underneath, each contributing according to the weight configuration of the metric scorecard, and its threshold.

With the exception of the Overall health scorecard, you can drill into any widget in the CMDB group view dashboard:

- In a scorecard widget: Click the large aggregated percent number or the health bar to drill into a more detailed dashboard for that KPI.
- In a chart widget: Click a bar to display a list of all the records that the bar represents.
- In lists: Click the ‘i’ icon to view a list of all the tasks or alerts related to the CI.

Color codes

The CMDB group view dashboard uses color codes when displaying aggregated health status. The status definitions are based on the threshold limits for each scorecard, defined in the CI Class Manager.

<table>
<thead>
<tr>
<th>Color code</th>
<th>Definition</th>
<th>Default threshold setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Best</td>
<td>Less than or equal to 33</td>
</tr>
<tr>
<td>Orange</td>
<td>At risk</td>
<td>More than 33 and less than or equal to 67</td>
</tr>
</tbody>
</table>
The icon is a notation that the maximum failure threshold for the scorecard has been reached. The tests for the metric are halted for this cycle, and all associated aggregated summaries display 0%.

View CI health

The CI dashboard is a central location displaying health report for an individual CI, history of changes to the CI in a timeline view, and the relation formatter. The CI dashboard also displays incidents, changes, and other tasks affecting the CI, and business services affected by the CI. You can access the CI dashboard from a CI form, or from the CMDB dashboard.

Role required: asset or itil

The health scores are based on settings of CMDB Health KPIs and metrics. The report is calculated in real-time from data stored in health-related tables which the CMDB Dashboard jobs update on a recurring schedule. The completeness and correctness KPIs are always up to date, but for other KPIs, it is possible that updates to the CMDB are not reflected because one of the dashboard jobs hasn’t run yet, as follows:

- Compliance: Depends on audit cycles and on the ‘CMDB Health Dashboard - Compliance Score Calculation’ job.

To ensure that the latest updates to these KPIs are reflected on the CI dashboard, navigate to the respective dashboard job, and click Execute Now.

1. On a CI form click Dashboard.
2. Or, navigate to CMDB Dashboard > CMDB Health and click CMDB Dashboard - All to display the class hierarchy. Enter a search string and then select a CI from the Configuration Items group.
   The search results are grouped by Classes and Configuration Items that match the search string.

Various widgets in the report display CI’s health with the following color codes:

- Green: The CI passed the health test (for example, it is not a duplicate).
- Red: The CI failed the health test (for example, it is a duplicate)
- Grey: The CI was not tested for this metric, because the threshold was not set for the CI (class) in the CI module.

The report displays the change history for the CI in a timeline format, that you can zoom in or out to select a time period for which to display details for. Use the related lists tabs Change, Incident, Task, Business Services, and Alerts to further drill into additional details.

Note:

Missing rules or other class definitions can prevent some health scores from being evaluated for a CI. The results in the CI dashboard in these situations, are described below:

Duplicate
• If no identification rules ([cmdb_identifier]) are defined for the CI’s class or its ancestors: A notification to that effect appears.
• If only dependent identification rules are defined: Not applicable notification appears.

Orphan
• If the CI is excluded by health inclusion rules: Not applicable notification appears.
• If no orphan rules ([cmdb_health_orphan_rule]) are defined for the CI’s class or its ancestors: A notification about missing a rule appears.

Staleness
• If the CI is excluded by health inclusion rules: Not applicable notification appears.
• If no staleness rules ([cmdb_health_staleness_rule]) are defined for the CI’s class or its ancestors: A notification about missing a rule appears.

Audit
• If no audits ([cert_audit]) are defined for the CI (CI dashboard checks only desired states and scripted audits): Not applicable notification appears.
• If there are audits defined for the CI but the audits did not run: Not applicable notification appears.

Customize the CI dashboard
You can add, remove or re-arrange content on the CI dashboard to display the CI health statistics that are important to you.

Role required: itil_admin

On a CI form click Dashboard and customize the CI dashboard as follows:
• Drag a tile near its upper edge and drag it to a different location on the dashboard to rearrange the current layout.
• Click the X in the upper right side of a widget to hide the widget.
• Click the + sign in the upper left corner of the dashboard to add content. In the Add content dialog box, select the content to add and the location to place it.
• Click the gear icon in a widget tile to edit widget settings such as title and height.
• Click Reset to Default to revert to the base system settings.

View CI relationships health

View aggregated orphan, stale, and duplicate CI relationships in the CMDB dashboard. You can configure the relationship scorecards, but you cannot configure the underlying relationship KPI health tests.

The CMDB Health Dashboard - Relationship Compliance Processor dashboard job must run to generate data for these reports.

Role required: itil or asset

CMDB Health measures CI relationship health using a separate KPI and metrics.

Orphan relationship
A relationship that is missing parent, child, or relationship type.
Duplicate relationship
Relationships that have identical parent, child, and relationship type.

Stale relationship
A relationship in which one of the CIs is stale. For a stale CI — its associated relationships are also stale.

In addition, the following relationship compliance reports are available:

Relationships not compliant with all relationship rules
Relationships that do not comply with any relationship governance rule, including suggested relationships and dependent relationship rules.

Relationships not compliant with suggested relationships
Suggested CI relationships are used as rules to test if relationships comply with specified suggested relationships.

Relationships not compliant with containment rules
Containment rules are used to test if relationships comply with specified containment relationships.

Relationships not compliant with hosting rules
Hosting rules are used to test if relationships comply with specified hosting relationships.

For each of the compliance reports, testing a relationship requires a rule (suggested relationship, hosting rule, or containment rule) in which the parent and child CI classes match the parent and child CI classes in the tested relationship. If the relationship types in the rule and in the tested relationship do not match, then the relationship is not in compliance. If an applicable rule is not found, then the relationship is considered to be in compliance. Rules apply to the classes specified in the rule, and also to descendant classes. Therefore, when testing a relationship, rules that apply to ascendant parents of the CIs in the tested relationship are used. If there are multiple rules that match the parent and the child CI classes of the tested relationship, then the tested relationship needs to satisfy only one of these rules to be in compliance.

1. Navigate to Configuration > CMDB Dashboard > CMDB View.
2. Select the Relationship Health tab.
3. Scroll to the bottom of the page to examine the relationship compliance reports.
   Report results are grouped by relationship type, and you can drill down for further details:
   - Point to a relationship type to display its label and the % of relationships that are not in compliance.
   - Click on a relationship type to drill down to a detailed list of all the relations of that type that are not compliant. Click on a specific relationship to display more details such as the failure description. The Failure Description field lists only a single rule that the relationship did not comply with, even if there are additional rules that the relationship fails to comply with.

Create CMDB remediation rule
A CMDB remediation rule is associated with a task that was created for a failed CMDB health test. A CMDB remediation rule is applied automatically or manually to execute a remediation workflow that can, for example, delete stale CIs.

You need to first create and publish a remediation workflow that addresses the CI issue. The workflow can be a regular workflow, or an Orchestration workflow, and the table in the workflow needs to match the task type in the remediation rule. Do not configure the workflow with any filter conditions by setting If condition matches to None, so that the filters of the CMDB remediation rule will apply.

Role required: itil_admin (on top of itil)

1. Navigate to Configuration > CMDB Remediations.
2. Fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Remediation name.</td>
</tr>
<tr>
<td>Task type</td>
<td>Type of CMDB health-related tasks to apply the remediation to.</td>
</tr>
<tr>
<td>Task filter</td>
<td>Filters tasks to apply remediation to. Also applies dot-walking on CI fields so that remediation is applied to tasks associated with matching CIs.</td>
</tr>
<tr>
<td>Execution</td>
<td>• Manual: Remediation is applied manually.</td>
</tr>
<tr>
<td></td>
<td>• Automatic: The workflow is applied once, upon the creation of a task that matches the Task type and Task filter.</td>
</tr>
<tr>
<td>Active</td>
<td>Allowing the workflow to run.</td>
</tr>
<tr>
<td>Workflow</td>
<td>The CMDB remediation workflow (regular or Orchestration) that will execute automatically or manually, depending on the Execution setting. You can click the Lookup using list icon, and then click New to create a new workflow.</td>
</tr>
</tbody>
</table>

3. Click Submit.

If Execution is set to Automatic, then the business rule Run remediations for CMDBHealth task applies the remediation workflow to CIs that match the Task filter. If Execution is set to Manual, then you can manually apply the remediation workflow defined in the rule.

**Apply CMDB remediation**

Manually initiate a workflow to remediate a CI that failed a CMDB health test. For example, you can remediate CIs that are orphan or stale.

To manually apply a CMDB remediation, a CMDB remediation rule must exist, in which Execution is set to Manual.

Role required: itil_admin

Except for the duplicate and audit health metrics, you can choose to create tasks for health test failures for a metric.

To remediate failures of the duplicate metric, use de-duplication tasks.

For all metrics except for audit, each CI that failed a metric test is associated with a single task. Because a CI can fail multiple audits, a single CI can be associated with multiple audit tasks. The first of those tasks is in the Task field, and any additional tasks are in the Additional Tasks field. To remediate failures of the audit metric, refer to the audit tasks for the audits that the CI failed.

1. Navigate to Configuration > CMDB Dashboard, and then click CMDB View, Service View, or Group View.

2. Click on one of the bars in a bar chart on the page. Or, click on a metric tile that is associated with the remediation that you want to apply, and then in a detailed report click on a bar in a bar chart. For example, to remediate an orphan CI, click the Completeness tile.

3. In the Task column in the CMDB Health Results list, select the task that is associated with the CI that you want to remediate. Point to the information icon (i)
for a result record to display the CMDB Health Results dialog box with more details about the health test.
The CMDB Health Results list contains records only for the CIs that failed a metric test.

<table>
<thead>
<tr>
<th>Field</th>
<th>Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI</td>
<td>The CI associated with the test results.</td>
</tr>
<tr>
<td>Class Name</td>
<td>The CI's class.</td>
</tr>
<tr>
<td>Description</td>
<td>Details about the reasons for the CI failing the metric test.</td>
</tr>
<tr>
<td>Last Evaluated On</td>
<td>Time that the CI was evaluated for the metric, and which resulted in failure.</td>
</tr>
<tr>
<td>Metric</td>
<td>The CMDB Health metric associated with this test result.</td>
</tr>
<tr>
<td>Source</td>
<td>Source of the health test failure:</td>
</tr>
<tr>
<td></td>
<td>• CMDB Health Audit: Corresponds to the dashboard</td>
</tr>
<tr>
<td></td>
<td>• Cloud discovery</td>
</tr>
<tr>
<td>Task</td>
<td>The task associated with the health test failure.</td>
</tr>
<tr>
<td></td>
<td>For the audit metric, if there are multiple failures, then only the first task is listed.</td>
</tr>
<tr>
<td>Additional Tasks</td>
<td>If there are multiple tasks related to the audit metric, contains all tasks other than the first which is in the Task field.</td>
</tr>
<tr>
<td>Active</td>
<td>Used internally in combination with the To Delete field to determine the correct results set that this failure belongs to.</td>
</tr>
<tr>
<td>To Delete</td>
<td>Used internally in combination with the Active field to determine the correct results set that this failure belongs to.</td>
</tr>
</tbody>
</table>

4. On the task form, click Remediate.
5. In the Run Remediations dialog box, select the remediation rule that you want to apply.
   The list of remediation rules is based on the type of health metric (such as orphan, stale), and on the filter defined in the rule.
6. Click Execute.

Components installed with CMDB Health

Several types of components are installed with CMDB Health (included in the com.snc.cmdb plugin), including tables and scheduled jobs.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.
Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Health Dashboard - Completeness Score Calculation</td>
<td>Script for calculating the completeness KPI of CMDB health.</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Compliance Score Calculation</td>
<td>Script for calculating the compliance KPI of CMDB health.</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Correctness Score Calculation</td>
<td>Script for calculating the correctness KPI of CMDB health.</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Relationship Score Calculation</td>
<td>Script for calculating the CI relationships KPI of CMDB health.</td>
</tr>
<tr>
<td>CMDB Health Dashboard - Relationship Compliance Processor</td>
<td>Script for calculating compliance of relationships with suggested relationships, and with hosting and containment rules.</td>
</tr>
<tr>
<td>Add Identifier Fields In Recommended Rules</td>
<td>Sets all criterion attributes from all active identifier entries from all active identification rules, as recommended fields. These added recommended fields are then checked by the CMDB Health Dashboard - Completeness Score Calculation scheduled job when evaluating the recommended health metric.</td>
</tr>
<tr>
<td>Remove Identifier Fields In Recommended Rules</td>
<td>Identifies any recommended field that is a criterion attribute in any active identifier entry in any active identification rule. Then removes the recommended setting for that field.</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB Health Metric [cmdb_health_metric]</td>
<td>Details such as if a KPI or metric is enabled, maximum failure threshold, and other settings for all CMDB Health KPIs and metrics.</td>
</tr>
<tr>
<td>CMDB Health Result [cmdb_health_result]</td>
<td>Results from the most recent CMDB Health processing cycle.</td>
</tr>
<tr>
<td>CMDB Health Scorecard [cmdb_health_scorecard]</td>
<td>Current and historic health scores. Status of historic score records is ‘Historic’, and of latest score records is ‘Complete’.</td>
</tr>
<tr>
<td>CMDB Health Orphan Rule [cmdb_health_orphan_rule]</td>
<td>Rules for calculating orphan records per class.</td>
</tr>
<tr>
<td>CMDB Recommended Fields [cmdb_recommended_fields]</td>
<td>Recommended fields per class.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CMDB Health Metric Status</td>
<td>Internal table that tracks the status of each KPI and metric that is being processed. Includes status, processing time, and processing start date. State for a KPI or metric changes from 'In Progress' to either of:</td>
</tr>
<tr>
<td>[cmdb_health_metric_status]</td>
<td>• Complete</td>
</tr>
<tr>
<td></td>
<td>• MaxFailures</td>
</tr>
<tr>
<td></td>
<td>• Daily Processing Time Out</td>
</tr>
<tr>
<td></td>
<td>Processing of a timed out KPI or metric continues on the following day.</td>
</tr>
<tr>
<td>CMDB Health Processor Status</td>
<td>Internal table that tracks the processing progress of each KPI and metric. Contains a list of tables that are processed for each KPI and metric, and processing status. Classes are processed sequentially, changing status from Draft -&gt; In Progress -&gt; Complete.</td>
</tr>
<tr>
<td>[cmdb_health_processor_status]</td>
<td></td>
</tr>
<tr>
<td>CMDB Relationship All Rules Health Results</td>
<td>Stores results about relationship health, to be used by the All Relationships report.</td>
</tr>
<tr>
<td>[cmdb_health_result_rel_all]</td>
<td></td>
</tr>
</tbody>
</table>

**CMDB Health process tracking**

Use the following information to track and resolve issues with the CMDB Health processes.

**Logging**

By default, only error messages are logged to the syslog table, with the source name CmdbHealth. To enable logging of 'info' and 'warning' messages (which are typically logged at the start and end of each processing cycle), update the system property glide.cmdb.logger.use_syslog.CMDBHealth. For information about using this property, see [CMDB Health system properties](#).

**Processing status**

If scheduled jobs are enabled, but data is not displaying on the CMDB dashboard, you can check the processing status in the CMDB Health Metric Status [cmdb_health_metric_status] table. Depending on the status of the inactive metric, decide how to proceed.

Initially, the state of all metrics is 'In Progress'.

Possible final states of a metric:

**Complete**

All classes are processed and the number of failures is under the maximum failures threshold.

**Max Failures**

The number of failures for this metric reached the maximum failures threshold. Processing has been aborted and will start over in the next run.

**Daily Time Out Pause**
The processor reached the processing time limit. Processing is paused and will resume in the next run.

At the end of a processing cycle, the final state of a KPI depends on the final state of its associated metrics. Possible final state of a KPI:

**Complete**

All associated metrics are in Complete state and score calculation is complete.

**Incomplete**

Score is not calculated because one of the associated metrics reached its maximum failure thresholds.

**Daily Time Out Pause**

Timed out because one of the associated metrics has reached its processing time limit.

**Processing time**

If processing of a metric times out, you can find out which class takes too long to process. Use this information to find out if any validation rules are weak.

The progress of each metric is tracked in the CMDB Health Processor Status table [cmdb_health_processor_status]. Status for classes that have been processed for a metric is Complete, and for classes that are yet to be processed is Draft. By looking at the update time for each class, you can calculate the length of processing time for each class.

**Orphan records due to broken hierarchy**

Orphan rules might detect an orphan CI, which you are not able to access and delete. Or, there might be a mismatch between the list view that displays the orphan records, and the total number of records. These findings are due to records being deleted in the database from only one table in the CMDB hierarchy.

These CI records are not accessible via GlideRecord and must be deleted directly from the database. Therefore, in this case, to delete an orphan CI from the database you must get help from ServiceNow Technical Support.

Orphan test results provide the details of where exactly the hierarchy is broken. For example, the message “This cmdb_ci_linux_server CI [91054fc24f22520053d6e1d18110c713] is missing record in cmdb_ci_computer table” means that a record of that sys_id must be deleted from the CMDB, cmdb_ci, cmdb_ci_hardware, cmdb_ci_server, and the cmdb_ci_linux_server tables (the Computer class is between the Hardware and the Server classes in the hierarchy.)

**Scripted audits Skipped**

An error message is logged if the results from a scripted audit are not included in the compliance KPI. The reason can be that the script in the audit was not updated to populate its *Last ran date* field. Without a *Last ran date* value, CMDB Health is unable to identify these run results as part of a recent complete audit run, and skips those results.

**CMDB Health process status: failure threshold reached**

The CMDB dashboard displays the string ‘failure threshold reached’ when the number of CIs that are failing the metric tests, reaches the failure threshold set for the metric.

CMDB Health stops processing for this metric in the current cycle, and therefore there is no aggregated health score for the metric. Processing will be attempted again in the next cycle. Also, status in the CMDB Health Metric Status [cmdb_health_metric_status] table is set to Max Failures for this metric.
When the health score of a metric cannot be evaluated, then the processing status of the respective KPI (for example, correctness) is set to **Incomplete**. The CMDB dashboard displays the string **Incomplete score** for the respective KPI and for the CMDB Health overall score. Also, aggregated health scores for the metric are not available for any class in the CMDB hierarchy.

Review and adjust the following definitions as needed:

- Review and refine the rules defined for the metric which has reached max failures. If a rule associated with the metric is too generic, resulting in large number of failures, attempt to refine it. For Example:
  - Completeness – Review the recommended fields that are causing failures and remove the ones that are not critical for the health score. For more information see Set a CI field to be recommended.
  - Correctness – For the staleness metric, depending on the cause of the failures it might be helpful to increase the value of the `glide.cmdb.health.staleness` CMDB Health system property.

- Reduce the number of failures by fixing CI records: If after adjusting the metric test rules the max failures for some metrics is still reached, then address the failures by updating CI records with the relevant missing information.

- **Increase the failure threshold** for the metric that is failing and check if processing for this metric completes successfully in the next cycle. Increasing the failure threshold beyond 500K might reduce overall performance.

**CMDB Health process status: incomplete score**

The CMDB dashboard displays the string ‘incomplete score’ for a metric when it fails to calculate the score for the metric.

'Incomplete score’ is displayed when:

- The number of CIs that are failing the tests of one of its sub-metric, reaches the failure threshold set for the metric. In this situation, the processing status for the respective parent metric (for example, correctness) is set to ‘incomplete’ in the CMDB Health Metric Status `[cmdb_health_metric_status]` table. Processing for the failing metric in the current cycle stops, and therefore there are no aggregated health scores for the sub-metric, the parent parent metric, or the overall CMDB Health.

  To remediate, you need to resolve the underlying cause of CIs failing the sub-metric tests. See CMDB Health process status: failure threshold reached for more information about resolving the failures of the sub-metric.

- An error is encountered while processing the sub-metric.

  To remediate, examine the system logs system logs to determine the cause of the error. After fixing the cause of the problem, restart processing by manually executing the respective parent metric dashboard job.

**Duplicate CIs**

When the instance encounters duplicate CIs during identification and reconciliation, it groups each set of duplicate CIs into a de-duplication task for review and remediation.

**De-Duplication tasks**

De-duplication tasks provide details about the duplication, including a list of all the duplicate CIs. Review the details of each duplicate CI in the task and the data that was used to determine that the CI is a duplicate.

From a de-duplication task, you can run the Duplicate CI Remediator wizard to reconcile a set of duplicate CIs into a single CI, eliminating the duplication.
Duplicate CI Remediator

The Duplicate CI Remediator is a wizard-like tool that you can use to reconcile a set of duplicate CIs associated with a de-duplication task. You can choose one of the duplicate CIs to retain as an active CI, and then decide how to process the rest of the duplicate CIs. The Duplicate CI Remediator lets you set reconciliation options for attributes, relationships, and related items.

For information about using the Duplicate CI Remediator, see Remediate a de-duplication task.

Properties that affect processing of duplicate CIs

During CMDB Identification, processing of sets of duplicate CIs is determined by:

- Property `glide.identification_engine.skip_duplicates` (true by default).
- Property `glide.identification_engine.skip_duplicates.threshold` (5 by default).
- Number of duplicate CIs in a set.

For information about how these properties affect the management of duplicate CIs, see Detecting duplicate CIs.

Master CI

The master CI plays an important role in the remediation of duplicate CIs. The master CI is a single CI from a set of duplicate CIs, that remains active while the rest of the duplicate CIs in the set are potentially retired, deleted, or reconciled into the master CI. Using the Duplicate CI Remediator, you can select a master CI for a set of duplicate CIs associated with a de-duplication task.

The `duplicate_of` attribute in duplicate CIs, is used to store a reference to the master CI. For duplicate CIs which existed in an instance that was upgraded to the New York release or later, the master CI is unknown. After upgrade, `duplicate_of` for those duplicate CIs is set to 'Unknown', indicating that the CI is a duplicate but the master CI is unknown.

Duplicate CIs set

Before remediation, the CIs in a duplicate CIs set are all duplicates of each other. After remediation, a set of duplicate CIs consists of one master CI, and any number of CIs, each considered a duplicate of the master CI. The `duplicate_of` attribute of the master CI is empty. The `duplicate_of` attribute for all the rest of the duplicate CIs in the set, is a reference to the master CI of the set.

If you attempt to modify the value of `duplicate_of` directly on a CI form or by using a script, the following restrictions are enforced to ensure data integrity:

- A CI cannot be its own master CI (you cannot set a CI as a duplicate of itself).
- A CI and its master CI cannot be from different domains.
• The `duplicate_of` attribute of the master CI cannot reference any CI as its master CI (you cannot set a CI as a duplicate of another duplicate CI to create a chain of duplicate CIs).

• If you attempt to set a CI as a duplicate of another duplicate CI, then the CI is set as a duplicate of the master CI of the duplicate CI you are trying to set. If the master CI of the duplicate CI you are trying to set is 'Unknown', the operation fails.

**Example: Attempt to set a CI as duplicate of another duplicate CI**

<table>
<thead>
<tr>
<th>CI1: <code>duplicate_of = empty</code></th>
<th>CI2: <code>duplicate_of = CI3</code></th>
<th>CI3: Master CI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attempted setting</td>
<td><code>CI1: duplicate_of = CI2</code></td>
<td><code>CI1: duplicate_of = CI3</code></td>
</tr>
<tr>
<td>Result (System enforced)</td>
<td><code>CI2: duplicate_of = CI3</code></td>
<td><code>CI3: Master CI</code></td>
</tr>
</tbody>
</table>

If CI2 is a duplicate of 'Unknown', the operation fails.

• If a master CI becomes a duplicate of another CI, then it can no longer be a master CI. All CIs that were duplicates of that master CI are set as duplicates of the new master CI.

**Example: Attempt to set a master CI as duplicate of another CI**

<table>
<thead>
<tr>
<th>CI1: <code>duplicate_of = CI4</code></th>
<th>CI2: <code>duplicate_of = CI4</code></th>
<th>CI3: <code>duplicate_of = CI4</code></th>
<th>CI4: Master CI</th>
<th>CI5: <code>duplicate_of = empty</code></th>
</tr>
</thead>
<tbody>
<tr>
<td>Attempted setting</td>
<td><code>CI4: duplicate_of = CI5</code></td>
<td><code>CI4: duplicate_of = CI5</code></td>
<td><code>CI4: duplicate_of = CI5</code></td>
<td><code>CI4: duplicate_of = CI5</code></td>
</tr>
<tr>
<td>Result (System enforced)</td>
<td><code>CI1: duplicate_of = CI5</code></td>
<td><code>CI2: duplicate_of = CI5</code></td>
<td><code>CI3: duplicate_of = CI5</code></td>
<td><code>CI5: Master CI</code></td>
</tr>
</tbody>
</table>

• If a master CI becomes a duplicate of a CI within the same duplicate CI set, then the selected duplicate becomes the master CI in the duplicate CI set. The rest of the duplicate CIs in the set are set as duplicates of the new master CI.

**Example: Attempt to set a master CI as duplicate of a CI within the duplicate CIs set**

<table>
<thead>
<tr>
<th>CI1: <code>duplicate_of = CI4</code></th>
<th>CI2: <code>duplicate_of = CI4</code></th>
<th>CI3: <code>duplicate_of = CI4</code></th>
<th>CI4: Master CI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attempted setting</td>
<td><code>CI4: duplicate_of = CI1</code></td>
<td><code>CI1: Master CI</code></td>
<td><code>CI1: Master CI</code></td>
</tr>
<tr>
<td>Result (System enforced)</td>
<td><code>CI2: duplicate_of = CI1</code></td>
<td><code>CI3: duplicate_of = CI1</code></td>
<td><code>CI4: duplicate_of = CI1</code></td>
</tr>
</tbody>
</table>

• You cannot delete a CI that is the master CI of duplicate CIs. To delete a master CI, you must first disassociate that master CI with all of its duplicate CIs. Either delete all duplicate CIs that are associated with that master CI, or remove the reference to that master CI from all `duplicate_of` attributes in any duplicate CIs that have it.

**Review de-duplication tasks**

Review details of de-duplication tasks, and then potentially remediate a de-duplication task.
Role required: itil to view and itil_admin to remediate a de-duplication task.

If a duplicate CI is a dependent CI, then you can view the details of the dependent relationship, the Depend on CI, and any relation qualifier chain. If the dependent CI has a lookup table, then you can see the details of the respective lookup table.

1. Navigate to **Configuration > Identification/Reconciliation > De-duplication Tasks**.
2. Select a task.

### Remediate Duplicate Task form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique task number.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Person who is responsible for resolving the task.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description for the task.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Details describing how the CI was identified as a duplicate.</td>
</tr>
</tbody>
</table>

**Note:** Not available in de-duplication tasks that were created prior to the London release.

This field also contains user notes about the decisions and steps of resolving the task.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>Task priority.</td>
</tr>
<tr>
<td>State</td>
<td>State of the de-duplication task as it progresses through resolution.</td>
</tr>
</tbody>
</table>

3. In the related lists section, click the **Duplicate Audit Results** tab to see the list of duplicate CIs in this task. You can click a CI to display more CI details.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate CI</td>
<td>Reference to the duplicate CI.</td>
</tr>
</tbody>
</table>

**Note:** This field is a document ID type, which means that it can reference any record on any table. If the referenced CI is deleted as part of resolving duplicate tasks, then this field is empty.

<table>
<thead>
<tr>
<th>Relationship</th>
<th>For a duplicate CI that is a dependent CI, this field shows the relationship between the duplicate CI and depend on CI.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depend on CI</td>
<td>If the duplicate CI is a dependent CI, then this field displays the depend on CI.</td>
</tr>
<tr>
<td>Discovery source</td>
<td>Discovery method used for the CI.</td>
</tr>
</tbody>
</table>

Analyze de-duplication tasks to determine which CIs should remain active and which of the duplicate CIs in the Duplicate Audit Results lists are stale or incorrect. Click **Remediate** to remediate a de-duplication task (requires the itil_admin role).
Manually create a de-duplication task

Manually create a de-duplication task when it cannot be automatically created. You can then use the Duplication CI Remediator to remediate the manually created task.

In some situations, duplicate CIs are not automatically detected and de-duplication tasks are not automatically generated. Such situation happens with a class for which identification rules are not defined and the identification engine cannot be applied. However, you still want to reconcile these duplicate CIs by utilizing the Duplication CI Remediator.

Use the CMDBDuplicateTaskUtils API to manually create a de-duplication task in which all duplicate CIs are specified. The de-duplication tasks that you create manually and the automatically created tasks, are stored in the same table ([reconcile_duplicate_task]) and are processed in the same manner.

**Note:** You can manually create a de-duplication task only for CMDB CIs and a CI can be specified as a duplicate CI only in a single de-duplication task.

Remediate a de-duplication task

Remediate a de-duplication task by using the Duplicate CI Remediator wizard. Use the wizard to guide you through the duplicate CI reconciliation process or to apply a custom workflow.

Important concepts associated with the Duplicate CI Remediator:

**Master CI**

The master CI is one of the duplicate CIs that you want to retain as an active CI while potentially retiring or deleting the rest of the duplicate CIs. The first step in the Duplicate CI Remediator is to select a master CI for the remediation process. The Duplicate CI Remediator lets you choose which attribute values, relationships, and related items from the duplicate CIs to reconcile into the master CI. Alternatively, you can choose not to consolidate any data and retain the master CI as it is.

**Default related items list**

A list of related items that is used globally in the Duplicate CI Remediator for all de-duplication tasks. All items from the default related items list are selected by default to be merged to the master CI, on the Merge Relationships and Related Items tab. Adding or removing items from that slushbucket does not affect the default related items list. See Manage default related items list for more information.

**Note:** Asset related tables are not included in the default related items list and therefore they are not available for merge.

Review Properties for duplicate CIs for information about important properties that affect how the Duplicate CI Remediator operates. Including the glide.duplicate_ci_remediator.dry_run property that determines if the Duplicate CI Remediator actually updates the CMDB or not.

Role required: itil user to read and itil_admin to write

As you progress through the tabs of the Duplicate CI Remediator, CIs are not updated. All updates are applied only in the final step, after you click Remediate.

**Note:**
- Merging of attributes and related items that are associated with assets is not supported in the Duplicate CI Remediator.
1. Navigate to **Configuration > Identification/Reconciliation > De-duplication Tasks**.
2. Open the de-duplication task that you want to remediate. On the task form, click **Remediate**.
3. In the Remediate dialog box, select either of the following options:
   - **Use the Duplicate CI Remediator (Recommended)**: Use the wizard to consolidate duplicate CIs according to your configurations and settings. Follow the Duplicate CI Remediator tabs to configure the reconciliation.
   - **Use a custom remediation workflow**: Use an existing CMDB remediation rule or select **Add New** to create a new one.

   - On the CMDB Remediation Rule form, set **Task type** to **Remediate Duplicate Task** and select **Active**.
   - On the Workflow form, set **Table** to **Remediate Duplicate Task [reconcile_duplicate_task]** and set **If condition matches** to **None**.
   - Ensure that the associated workflow remediates duplicate CIs.

   In the Remediate dialog box, click **Next** to start the workflow and to exit the Duplicate CI Remediator. The RemEDIATE Duplicate Task form appears, where you can update the **State** of the task.

4. On the **Select Master CI** tab in the Duplicate CI Remediator:
   a) Select the master CI for this reconciliation using either of the following lists of duplicate CIs. For any CI, you can click the **Name** link to display the CI's attributes, or click the **Related Items** link to display the number of related items.

      - **Recommended**: A subset of the **All** list, containing only system recommended master CIs. System recommendations are based on checking the duplicate CIs for the following criteria:
        - CI with most related items.
        - CI with most relationships.
        - Newest discovered CI.
        - Newest updated CI.
        - Oldest created CI.
        - Previous master CI, if one was previously selected.

      - **All**: All duplicate CIs for the de-duplication task.

   Either option lets you review a summary of the remediation settings before starting the remediation.

   b) Select one of the following options to choose whether to consolidate any attribute values, relationships, or related items from any of the duplicate CIs into the master CI:

      - **Remediate Manually**: Lets you specify which attribute values, relationships, and related items from duplicate CIs to consolidate into the master CI.
      - **Use Master CI**: Retains master CI attribute values, merges relationships, and merges only the default related items.

   Skip to step number 7 as this selection skips all configurations other than choosing the action for the duplicate CIs on the **Determine Duplicate CI Actions** page.
5. On the **Merge Attribute Values** tab review inconsistent values of each attribute. For each attribute, choose to retain the master CI's value, or choose a value from a duplicate CI for the master CI to be set with. Then click **Next**.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>Attribute for which there are different values.</td>
</tr>
<tr>
<td>Master CI Value</td>
<td><strong>Attribute</strong> value in the master CI.</td>
</tr>
<tr>
<td>Other Values</td>
<td>The number of unique <strong>Attribute</strong> values within the duplicate CIs.</td>
</tr>
</tbody>
</table>

To override the master CI attribute value with a duplicate CI value:

a) Click the **Other Values** link.

b) In the attribute dialog box, click **Unique Values** to display only unique attribute values, or **All** to display all attribute values including identical values.

c) Select a value for the master CI **Attribute** to be set with.

   You can click **Reset to Original** to undo the selection of a different attribute value for the master CI.

d) Click **Select**.

**Note:** Attributes, such as system fields, discovery fields (**discovery_source**, **last_discovered**, **first_discovered**), and read-only fields (such as the asset field) do not appear in the list.

6. On the **Merge Relationships and Related Items** tab:

a) In the Merge Relationships section, select whether to merge all relationships from all duplicate CIs into the master CI. Click **View all relationships** to display all the relationships in which a duplicate CI is a parent or a child. You can click a **Parent** or a **Child** link to display more details. Orphan and duplicate relationships of duplicate CIs are deleted if you choose to merge relationships. For more information about the CMDB Health relationship KPI, see **CMDB Health KPIs and metrics**.

b) In the Merge Related Items section use the slushbucket to select related items to be merged into the master CI. Click **View all related items** to display all related tables (items) and the count of
references in each table to one of the duplicate CIs. You can click the links in Master CI Related Items and Duplicate CIs Related Items to display details about the related items.

Related items in the slushbucket have the following format:

- By default, all items in the default related items list are selected to be merged.
- Related items (tables) that have no references to a duplicate CI are not listed, unless that table is included in the default related items list.
- Since asset related tables are part of the blacklist, they are not available for merge.

See Manage default related items list for more information about configuring a default list of related items.

c) Click Next.

7. On the Determine Duplicate CI Actions tab, choose one of the following actions to perform after completing the reconciliation. Then click Next.

- **Set attributes to custom values** (recommended): Retain all duplicate CIs. Mark the duplicate CIs as invalid by setting a specific Attribute to a specific Value for all duplicate CIs. For example, set Operational Status to Retired to retire the duplicate CIs. The duplicate_of attribute of the duplicate CIs is automatically set to the appropriate master CI. Also, the duplicate CIs will not be added to any de-duplication task after this task is remediated. If the identification engine is not configured to skip duplication, ensure that identification inclusion rules are configured to exclude the duplicate CIs during identification. This configuration prevents new de-duplication tasks with the same duplicate CIs from being created after remediation.

  - **Note:** Discovery fields, system fields, read only fields, and date fields are excluded from the attributes list.

- **Delete**: Delete all duplicate CIs (only the master CI remains).

  - **Note:** Review Roll back and delete recovery for information about reverting the deletion of CIs and related records.

8. On the **Review and Confirm** tab:

a) Review the summary of the expected updates for this duplicate CIs reconciliation. Updates are based on your selections and therefore the summary includes only the details that are applicable. This summary can include details of the relationships and related items that will be merged to the master CI, the attribute values that the master CI will be set with, and the number of CIs that
will be deleted. Click Attributes, Relationships, Related Items, or Duplicate CI Actions if applicable, to display further details such as changes to attribute values.

b) Click RemEDIATE to complete the reconciliation according to your reconciliation settings. Once complete, the task State is set to Closed Complete.

The following relationships are deleted without being merged to the master CI:

• Relationships in which the type, child, or parent field is empty.
• Relationships for which merging to the master CI will result in cyclic relationships.
• Relationship for which merging to the master CI will result in duplicate relationships.

The reconciliation process runs in the background and may take a while to complete. Upon completion, the system sends a confirmation notice to the remediator of the task. Meanwhile, you can:

• Review Identification Rules: Review identification and inclusion rules and make any necessary updates to reduce CI duplication.
• Check Progress: View the task activities that are logged as the remediation progresses.
• View Master CI: View the master CI for this reconciliation process.

Special remediation scenarios

There are a few special remediation scenarios in which the Duplicate CI Remediator behaves differently.

Large number of duplicate CIs

Support for reconciliation of duplicate CIs in the Duplicate CI Remediator is limited when the number of duplicate CIs exceeds a certain threshold. This threshold is based on the value of the glide.duplicate_ci_remediator.max.cis property, which is 1,000 by default. You can update this property to increase the threshold. However, this threshold never exceeds 5,000, even if you set the property to a value greater than 5,000.

When the number of duplicate CIs for a de-duplication task exceeds the threshold, the options available in the wizard are limited:

• On the Select Master CI tab, only the Recommended list of master CIs appears, and only the Use Master CI option is available.
• Recommendations are based only on the oldest created, newest updated, and most recently discovered CIs.
• Reconciliation of attribute conflicts and CI relationships is not supported, and only default related items are reconciled.

Duplicate serial numbers:

The Duplicate CI Remediator is usually applied to duplicate CMDB CIs. However, in some situations de-duplication tasks might be created for duplicate serial numbers. When the Duplicate CI Remediator processes duplicate serial numbers, the merge of relationships from duplicate records, is not referenced and is not applied.

Manage default related items list

You can add or remove items from the default list of related items which is used globally in the Duplicate CI Remediator for all de-duplication tasks.

Role required: itil_admin
The default related items list appears on the **Merge Relationships and Related Items** tab in the Duplicate CI Remediator. Globally modifying the list affects all de-duplication tasks being remediated by the Duplicate CI Remediator.

Alternatively, you can modify the list for only a specific task in the Duplicate CI Remediator without affecting the default global list.

**Note:** Only related items in which the reference field points to Configuration Item `[cmdb_ci]` in `sys_dictionary` can be selected for the default related items list. Related items with references to any child of the Configuration Item class cannot be selected for the default related items list, but are still available for merging in the Duplicate CI Remediator for a specific task.

1. Navigate to **Configuration > Identification/Reconciliation > Duplicate CI Remediator Default Related Items**.
2. On the Default Related Items List for Duplicate CI Remediator page, use the slushbucket to add or remove items from the **Selected** list.
3. Click **Save**.

### Properties for duplicate CIs

Use the properties for duplicate CIs to configure how duplicate CIs are processed.

These properties are available for duplicate CIs. To view and edit these properties, the admin role is required.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes in which <code>max_length</code> exceeds this property value (4000 by default) are excluded from the <strong>Select Master CI</strong>, <strong>Merge Attribute Values</strong>, and <strong>Determine Duplicate CI Actions</strong> tabs in the Duplicate CI Remediator wizard.</td>
<td>If the <code>max_length</code> for an attribute is equal to the property value, and the size of the data exceeds the property value, then the data is truncated to the property value and the attribute appears in attribute lists.</td>
</tr>
<tr>
<td>glide.duplicate_ci_remediator.max.field_length</td>
<td>• Type: integer&lt;br&gt;• Default value: 4000&lt;br&gt;• Location: <strong>Configuration &gt; CMDB Properties &gt; Duplicate CI Remediator Properties</strong>&lt;br&gt;<strong>Note:</strong> This property impacts the performance of de-duplication tasks, therefore be cautious about setting this value.</td>
</tr>
<tr>
<td>Comma separated list of related tables in the format <code>&lt;table&gt;,&lt;reference column&gt;</code>, that are excluded from merging during duplicate CI remediation.</td>
<td>• Type: string&lt;br&gt;• Default value: cert_task.cmdb_ci,cert_audit_result.configuration_item,discovery_log.cmdb_ci,alm_hardware.ci,alm_asset.ci,fm_expense_line.ci&lt;br&gt;• Location: <strong>Configuration &gt; CMDB Properties &gt; Duplicate CI Remediator Properties</strong></td>
</tr>
</tbody>
</table>
### Property

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Threshold for the number of duplicate CIs, which if exceeded, support for reconciliation in the Duplicate CI Remediator is limited (1,000 by default). glide.duplicate_ci_remediator.max.cis | - Type: integer  
- Default value: 1000  
- Location: Configuration > CMDB Properties > Duplicate CI Remediator Properties  
- Learn more: See 'Large number of duplicate CIs' in Remediate a de-duplication task.  
This threshold never exceeds 5,000, even if you set the property to a value greater than 5,000. |
| Determines whether the Duplicate CI Remediator actually remediates CI duplication by updating records in the CMDB, or not. glide.duplicate_ci_remediator.dry_run | - Type: true | false  
- Default value: false  
- Location: Configuration > CMDB Properties > Duplicate CI Remediator Properties  
When set to false (default value), updates specified in the wizard are actually performed.  
You can set this property to true and then test run through the Duplicate CI Remediator without any records actually being updated. In this case, the work notes for the task describe the changes that will happen in an actual remediation. |

### Components installed for duplicate CI remediation

Tables installed to support duplicate CI remediation (included in the com.snc.cmdb plugin).

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remediate Duplicate Task [reconcile_duplicate_task]</td>
<td>De-duplication tasks.</td>
</tr>
<tr>
<td>Duplicate Audit Result [duplicate_audit_result]</td>
<td>CIs associated with each de-duplication task.</td>
</tr>
<tr>
<td>Duplicate CI Remediation [cmdb_duplicate_ci_remediation]</td>
<td>Input, selections on each tab, overall status of remediation, and results of each run of the Duplicate CI Remediator.</td>
</tr>
</tbody>
</table>

### CI Class Manager

Use the CI Class Manager to centrally view, create, or edit basic class definitions, and class settings for identification, reconciliation, and CMDB Health. To access the CI Class Manager, navigate to Configuration > CI Class Manager.
Class Basics
- Create a class
- View class basic information
- Class columns
- Add a suggested relationship
- Display all CIs for a class
- Dependency Views map icons for a class
- Delete CIs for a CMDB class

CMDB Health
- CMDB Health orphan rule
- CMDB Health staleness rules
- Set a CI field to be recommended
- Set a CI attribute to be mandatory
- CMDB health scorecard thresholds
- Health inclusion rules

Identification and Reconciliation
- Identification:
  - CI identification rules
  - Identification inclusion rules
- Reconciliation:
  - CI reconciliation rules
  - Data source precedence rules
  - Data refresh rules
- Dependencies:
  - Dependent relationship rules (hosting and containment)

Service Mapping
- Entry point types for Service Mapping
- CI types for Service Mapping and Discovery

Agent Workspace for Configuration Management Database (CMDB)
Agent Workspace for CMDB provides an easy-to-navigate interface that helps service agents access essential CMDB configuration items and drill-down to related items such as changes, incidents, and timeline.

Agent Workspace for CMDB provides:
- Key health scores for CIs
- Level 1 CI relationships
- Condensed timeline view of incidents, changes, and change requests for a CI, for the past 7, 14 (default), or 30 days
- Critical incidents and change requests for CIs
- Critical attributes related to CIs.
- Ability to create incidents and change requests for CIs, and to delete a CI

Plugins
The CMDB Workspace plugin (com.cmdb-workspace) is activated by default in a base system. The CMDB Workspace plugin adds the following to Agent Workspace:
- CMDB list category and associated filtered lists: Servers, Workstation, and Network Gear
- Configured workspace forms for common CMDB tables
- CMDB-specific widgets: CMDB Health, CMDB Relationships, and CMDB Timeline

Roles
To access Agent Workspace for CMDB, the workspace_agent and itil roles are required.
CMDB Workspace form view in Agent Workspace

Service agents see forms in the Workspace form view for the CMDB tables that this view is configured for:

The Workspace form view for CMDB tables contains the following components:

Widgets
• **CI Health:**
  Shows Critical Incidents, Change Requests, and the following CMDB Health scores: incomplete attributes, non-compliant relationships, stale relationships. Lets you open the CI Dashboard.

• **Level 1 Relationships:**
  Shows level 1 relationships. Lets you open the Dependency Views map.

• **CI Timeline:**
  Shows record changes, change requests, and incidents on a timeline. The timeline is for the past 14 days, condensing details that might be relevant to a current issue.

**Actions**
The **more** icon in the upper right corner lets you create a change, create an incident, or delete the CI.

**Related lists**
The Workspace form includes CIs' related lists such as Change Requests, Incidents, and Tasks, similar to related lists that appear on a CI form.

CMDB tables that do not have a Workspace form view configured for, appear with the default workspace form view which you cannot update. You can configure Workspace form views for any additional CMDB table that is commonly used in your organization, for which a Workspace form is not configured by default.

For example, create a new form named 'Workspace' for the Business Service class. Then, add to the Workspace form Agent Workspace components such as a form header, and CMDB-specific ribbon items such as the CMDB Health widget. Next time that you open a CI of the Business Service class in Agent Workspace, the CI appears in a Workspace form.

**Browser support for workspaces**
Do not use Internet Explorer 11 to access any workspaces. If you are on the New York release and you are using Internet Explorer 11 with any workspace, such as Service Owner Workspace, Vendor Manager Workspace, or any other type workspace, you must migrate to a modern browser before you upgrade to future releases. Internet Explorer 11 will not be supported for workspaces after the New York release. See KB0683275 for more information on Internet Explorer 11, and see Generally supported browsers for more information about browsers and what you can use across the platform.

**View CI in Agent Workspace**
View various details for a CI using Workspace form view, in Agent Workspace. The Workspace form view provides details such as key health scores, a timeline view of incidents, changes, and change requests, and critical incidents, change requests, and attributes related to CIs.

CIs appear in a Workspace form view only if a Workspace form view is configured for the respective CMDB class. Otherwise, CIs appear in the default workspace form view, which you cannot update.

**Role required:** workspace_agent and itil

1. Navigate to **Agent Workspace** and click **Agent Workspace Home**.
2. Click **Lists**, navigate to **CMDB** and then to one of the classes such as **Servers**.
3. In the class list view, select a CI.

• Click the **more** icon in the upper right area and select **Create Change**, **Create Incident**, or **Delete** to delete the CI.

• In the CI Health widget, click **CI Dashboard** to open the CI Dashboard.
- In the Level 1 Relationship widget, click **Dependency Map** to open the Dependency Views map for the CI.

### Filtered lists for CMDB

Agent Workspace for CMDB includes by default the Servers, Workstations, and Network Gear filtered lists.

To edit filtered lists, navigate to **Agent workspace > List filters**.

<table>
<thead>
<tr>
<th>Filtered list</th>
<th>Criteria</th>
<th>Table columns</th>
</tr>
</thead>
</table>
| Servers       | All CIs under the cmdb_ci_server table | • Name (name)  
• Location (location)  
• Status (install_status)  
• Operating System (os)  
• Last Discovered (last_discovered)  
• Support Group (support_group)  
• Serial Number (serial_number)  
• Asset Tag (asset_tag) |
| Workstations  | Conditions for the following operating systems:  
• Mac OS 10 (OS/X)  
• Mac OS 8  
• Mac OS 9  
• Mac OS/X  
• Windows NT 4.0  
• Windows ME  
• Windows 95  
• Windows 98  
• Windows XP  
• Windows 7  
• Windows 8.1 Enterprise  
• Windows 10  
• Windows Embedded Standard | • Name (name)  
• Location (location)  
• Status (install_status)  
• Operating System (os)  
• Last Discovered (last_discovered)  
• Support Group (support_group)  
• Serial Number (serial_number)  
• Asset Tag (asset_tag) |
| Network Gear  | All CIs under the cmdb_ci_netgear table | • Name (name)  
• Manufacturer (manufacturer)  
• Model ID (model_id)  
• Serial Number (serial_number)  
• IP Address (ip_address)  
• Location (location) |

### Agent Workspace for CMDB tables

Agent Workspace for CMDB provides a number of CMDB tables with the Workspace form view layouts.
CMDB tables in Workspace view

Agent Workspace for CMDB provides the Workspace form view for common CMDB tables:

- Hardware [cmdb_ci_hardware]
- Computer [cmdb_ci_computer]
- Server [cmdb_ci_server]
- Linux Server [cmdb_ci_linux_server]
- UNIX Server [cmdb_ci_unix_server]
- AIX Server [cmdb_ci_aix_server]
- HP-UX Server [cmdb_ci_hpux_server]
- Solaris Server [cmdb_ci_solaris_server]
- Windows Server [cmdb_ci_win_server]
- Network Gear [cmdb_ci_netgear]
- Storage Server [cmdb_ci_storage_server]
- Storage Switch [cmdb_ci_storage_switch]
- IP Router [cmdb_ci_ip_router]
- IP Switch [cmdb_ci_ip_switch]
- Wireless Access Point [cmdb_ci_wap_network]
- Load Balancer [cmdb_ci_lb]
- F5 BIG-IP [cmdb_ci_lb_bigip]
- F5 BigIP GTM [cmdb_ci_lb_f5_gtm]
- F5 BigIP LTM [cmdb_ci_lb_f5_ltm]
- Virtual Machine Instance [cmdb_ci_vm_instance]
- VMware Virtual Machine Instance [cmdb_ci_vmware_instance]
- EC2 Virtual Machine Instance [cmdb_ci_ec2_instance]
- Hyper-V Virtual Machine Instance [cmdb_ci_hyper_v_instance]
- KVM Virtual Machine Instance [cmdb_ci_kvm_vm_instance]
- Solaris Virtual Machine Instance [cmdb_ci_solaris_instance]

CMDB Workspace adds records to the following Agent Workspace tables:

- [sys_aw_crud_exclusions]: For configured lists and related lists
- [sys_aw_list]: For Servers, Computers, and Network Gear
- [sys_aw.Ribbon_component] and [sys_ux_lib_component]: For the three CMDB widgets
- [sys_aw_form_header]: For each configured CI header
- [sys_aw.ribbon_setting]: For each configured CI ribbon
- [sys_ui_form_section], [sys_ui_section], and [sys_ui_element]: For each configured CI form

View CMDB benchmarks

CMDB calculates several CMDB Health benchmarks which then display in the Benchmarks dashboard. These benchmarks are based on various CMDB Health metrics, displaying monthly averages, trends, comparisons to industry averages of your ServiceNow peers, and global benchmarks.

The CMDB Health Dashboard jobs must be enabled and health data must be collected. Also, navigate to Benchmarks > Setup and ensure that the CMDB KPIs are enabled under IT Operations Management.

CMDB provides the following benchmarks:

- % of non-compliant CIs
- % of duplicate CIs
For an instance, each of these benchmarks is the calculated monthly average for the corresponding CMDB Health metric. Calculating a monthly average requires that there is a metric result value for each day of the month. Therefore, each day on which the respective Health Dashboard job did not run, is assumed with the aggregated result from the run that is most recent to that day. The monthly average is then calculated based on the sum of all the daily aggregated results for the metric in that month, divided by the number of days of the month. For a CMDB Health Dashboard job that ran multiple times in a single day, only the results of the last run in that day are used for the monthly average calculation.

Global averages are based on the sum of monthly averages of all peer instances, divided by the number of instances (aside from instances for which the monthly average is 0).

1. Navigate to **Benchmarks > Dashboard**.
2. Click the icon and select **IT Operations Management**.
3. Click **ALL** or **CMDB**.
4. Click on a CMDB benchmark to drill down to trend data, and other benchmark details.

**CMDB APIs (CMDB SDK)**

Use CMDB APIs to create, update, and read operations on the CMDB. Domain separation is supported in CMDB APIs.

**CMDB APIs (CMDB SDK)**

Use the following CMDB APIs to create, update, and read operations on the CMDB:

- CMDBGroupAPI - Scoped
- CMDBTransformUtil - Global
- CMDBUtil - Global
- IdentificationEngineScriptableApi
- IdentificationEngine - Scoped

**Domain separation in CMDB APIs**

Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

CMDB APIs are used for accessing the CMDB from a script. CMDB stores the CI and relation information; CMDB is domain separated.

CMDB APIs support the following operations:
• Create a new CI
  • This operation goes through the Identification and Reconciliation Engine which supports domain separation when creating a CI. The domain of the caller is used for this operation.

• Update an existing CI
  • This operation goes through the Identification and Reconciliation Engine which supports domain separation when creating a CI. The domain of the caller is used for this operation.

• Create/Delete relations
  • The cmdb_rel_ci table is not domain separated.

• Query CMDB CI/Query CMDB table
  • Results are filtered by the domain(s) visible to the caller.

• Query CMDB metadata table
  • Metadata information is not domain separated.

Setting up domain separation for CMDB APIs

If domain separation is enabled for CMDB, then it is also available for CMDB APIs.

Data separation

Data is stored and domain separated in CMDB. There is no additional work needed from the CMDB API perspective.

Configuring a domain-separated environment

The configuration is done at the CMDB level.

If a domain column is present for base system application tables

See the Domain separation in CMDB Health topic.

Tenant domains and application data

There is no application-specific data to manage with CMDB.

Quick start tests for Configuration Management Database (CMDB)

Validate that Configuration Management Database (CMDB) still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.
Configuration Management Database (CMDB) quick start tests require activating the Configuration Management (CMDB) plugin (com.snc.cmdb) and the CMDB - ATF Tests plugin (com.snc.cmdb.atf).

**CMDB: CI Health Dashboard test suite**

Test suite to check whether CMDB CI Health Dashboard is functional at a basic level.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB: Health Job Status</td>
<td>Checks whether any CMDB Health dashboard jobs, which were started 30 or more days ago, are still in progress.</td>
</tr>
</tbody>
</table>
| CMDB: CMDB Health Completeness/ Recommended | Checks whether the CI dashboard is functional for the recommended metric (included in the CMDB Health completeness KPI). This test validates:  
  • Creation of a health inclusion rule for the recommend metric.  
  • Creation of a recommended field that satisfies the health inclusion rule.  
  • Validate that the health inclusion rule is correctly applied to a test record with missing data in the recommended field. |

**CMDB: Query Builder test suite**

Test suite to verify CMDB Query Builder functions such as create query, read query, and execute query using two related user roles - cmdb_query_builder and cmdb_query_builder_read.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB: Query Builder - cmdb_query_builder Role</td>
<td>Verify that cmdb_query_builder user role can save queries, and access and run all saved queries, in CMDB Query Builder.</td>
</tr>
<tr>
<td>CMDB: Query Builder - cmdb_query_builder_read Role</td>
<td>Verify that cmdb_query_builder_read user role can access and run all saved queries, and cannot save any query, in CMDB Query Builder.</td>
</tr>
</tbody>
</table>

**CMDB: Relationship Editor and Formatter test suite**

Test suite to verify functionality of Relationship Editor and Relationship Formatter.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB:Relationship Editor</td>
<td>Check addition of relations to a CI and deletion of relations from a CI using itil user role.</td>
</tr>
<tr>
<td>CMDB:Relationship Formatter</td>
<td>Check accuracy of CI information, relationship types, relationships, associated records such as change tickets, and settings such as CMDB views (relationship filters), displayed for a specific CI in relationship formatter using itil user role.</td>
</tr>
</tbody>
</table>
CMDB: SDK REST API test suite

Test suite to verify functionality of CMDB SDK Rest APIs.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB: Query CMDB Metadata</td>
<td>Test querying CMDB metadata.</td>
</tr>
<tr>
<td>CMDB: Create a relation for a CI using REST APIs</td>
<td>Test creation of a relationship for a CI in the CMDB using the CMDB REST APIs.</td>
</tr>
<tr>
<td>CMDB: Delete a relation for a CI using REST APIs</td>
<td>Test deletion of a relationship for a CI using CMDB REST APIs.</td>
</tr>
<tr>
<td>CMDB: Create a CI using REST API</td>
<td>Test creation of a CI using CMDB REST APIs.</td>
</tr>
<tr>
<td>CMDB: Query CMDB using REST APIs</td>
<td>Test querying the CMDB using CMDB REST APIs.</td>
</tr>
<tr>
<td>CMDB: Update a CI using REST APIs</td>
<td>Test updating of a CI using CMDB REST APIs.</td>
</tr>
<tr>
<td>CMDB: Query for a CI using REST APIs</td>
<td>Test querying a CI using CMDB REST APIs.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB: IRE Validation</td>
<td>Validate CI identifiers and reconciliation definitions and check indexes for CI identifiers.</td>
</tr>
<tr>
<td>CMDB: Dependency Views</td>
<td>Test functionality of Dependency Views APIs. These APIs retrieve Dependency Views map and associated map items such as context menu items, for a given CI sys_id and using itil user role.</td>
</tr>
</tbody>
</table>

Useful related lists in CI forms

By default, the forms that display manageable configuration items (CI) - computers, printers, network gear, uninterruptible power supplies (UPS), and power distribution units (PDU) - provide a number of related lists for the form.

The following related lists are common to all forms for manageable CIs.

- Network Adapters - Displays all the NICs installed on a CI.
- CI IPs - Displays all the IP addresses on this CI:
  - Computers (workstations, laptops using various Mac and Windows operating systems)
  - Windows servers
  - Linux servers
  - AIX servers
  - Solaris servers
  - Devices discovered through SNMP.
- DNS Names for CIs - Displays all the DNS names on a CI.

The IP version information appears in all IP address related lists and forms.

Note: Since all paths here click into the IP Address to DNS Names list that associates an IP address with a DNS name, this part of the common flow was not added to the tree structure.
Discovery source

A table called Source [sys_object_source] stores information identifying the source of a discovery (by ServiceNow Discovery or another product), the ID of that source, and the date/time of the last scan. To view this information, configure a CI form and add the Sources related list. This table is populated automatically when the Discovery plugin is enabled.

Activate the Extended CMDB plugins

The Configuration Management (CMDB) application provides core functionality for the configuration management database, including modules for hardware and configuration items. The separate Extended CMDB plugin includes a collection of modules for specialized configuration items, such as radio hardware, test equipment, and voice system hardware.

Role required: admin

The Configuration Management (CMDB) plugin is automatically active for all instances. You must activate related plugins to access the modules for specialized configuration items.

- CMDB Mainframe (com.snc.cmdb.mainframe)
- CMDB Radio Category (com.snc.cmdb.radio.category)
- CMDB Telecom Category (com.snc.cmdb.telecom.category)
- CMDB Test Equipment (com.snc.cmdb.test.equipment)

1. Navigate to System Definition > Plugins.
2. Right-click the plugin name on the list and select Activate/Upgrade.
   If the plugin depends on other plugins, these plugins and their activation status are listed.
3. Optional: Select the Load demo data check box.
   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when first activating the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click Activate.

Help the Help Desk

Help the Help Desk is a tool that allows users to populate the CMDB automatically with information about their Windows computer.

Help the Help Desk is a small web application that downloads and runs locally, using a WMI login script to gather information such as serial number, computer name, disk configuration, network configuration, installed software, memory, and much more. Users have the option of using two types of SOAP authentication for running the Help the Help Desk script.

- Cookie-based authentication for Help the Help Desk
- Basic access authentication for Help the Help Desk

Note: Domain separation is not supported for Help the Help Desk.
User roles and user names

Users must have the hthd_user role, and only this role, to use Help the Help Desk from within an instance. The user should also be configured with web service access only.

For users without access to an instance, you can configure Help the Help Desk to allow users to run the script without login credentials. Users with access to an instance can also use Help the Help Desk configured in this way, but only if they have the hthd_user role.

User name cannot contain these characters: \n
Any user name that contains the \n characters prevents the Assigned to field on a computer from being populated.

Help the Help Desk device identification

Help the Help Desk uses a predefined series of queries to identify and update existing CIs in the CMDB or to create a new CI if no match is found. These queries attempt to match devices using three criteria in a certain order.

Updates to an existing CI require only a single match as the list is evaluated. For example, if a device's name has changed, but the MAC address is the same, the CI with the matching MAC address is updated.

- Serial number in the [cmdb_ci_computer] table
- MAC address in the [cmdb_ci_network_adapter] table
- Computer name in the [cmdb_ci_computer] table

Note: Discovery Identifiers are incompatible with Help the Help Desk queries.

Script include

The script include CIIdentifierForHelpDesk provides the logic for updating existing CIs or creating a new CI if no matching device exists in the CMDB. Do not modify this script. Errors introduced into this script can result in update failures or in new CIs being created for every device found.

Configure SOAP authentication for Help the Help Desk

By default, the ServiceNow system requires SOAP authentication. This affects the way in which your browser is configured for Help the Help Desk.

Role required: admin

1. Navigate to System Properties > Web Services.
2. Verify the system property for Require basic authorization for incoming SOAP requests glide.basicauth.required.soap is enabled.
3. Click Save.

Note: If you receive the error, There was a problem retrieving the XML data(0): Unknown, an authentication issue is preventing the script from sending information to your ServiceNow instance. Verify the user meets the requirements for Cookie-based authentication for Help the Help Desk or Basic access authentication for Help the Help Desk.
Cookie-based authentication for Help the Help Desk

Cookie-based authentication uses cookies generated by Windows Internet Explorer for SOAP authentication on the instance.

This type of authentication can be used to run the Help the Help Desk script at the time it is downloaded or after it has been saved to the local drive. When the script is downloaded, Internet Explorer generates a cookie using the user's login credentials, and then shares this cookie with the script. When a user attempts to run the script, the instance checks first for this cookie. If the cookie has been created, the script can authenticate on the instance through SOAP.
Cookie-based authentication

The following setup requirements are imposed on `.hta` file downloads by Microsoft.

- You must use Internet Explorer and choose to run the script while you are logged in to your instance. If you choose to use a different browser and download the script file to run later, the script will not work properly unless you have an active session on your instance with Internet Explorer.
- Disable Protected Mode and User Account Control (UAC). Protected Mode is available in Internet Explorer 7 or later in Windows Vista. UAC is a feature of Windows Vista and Windows 7.
- This feature requires that your logged in user session be persisted to the Help the Help Desk script. For this to occur, the Remember me check box in the login screen must be enabled and selected (the
default behavior). This option enables the system to write back an HTTP cookie to your browser to be persisted across sessions.

**Basic access authentication for Help the Help Desk**

An alternative to cookie-based authentication for the Help the Help Desk script is basic access authentication, which employs two properties to configure the script with credentials.

When a user logs in with the proper credentials, that user accesses the instance in the hthd_user role, which grants access to the ECC queue but limits the user's access to other features. The administrator then configures the system properties with the user name and password for the hthd_user user.

The values from these properties are automatically saved to the script file `helpthehelpdesk.js`. When this user runs the Help the Help Desk script, the instance checks for a cookie. If no cookie is found, the instance checks for the login credentials provided by the system properties, and authenticates the script automatically.

**Set up basic access authentication for the Help the Help Desk script**

You can set up basic access authentication for the Help the Help Desk script.

Role required: admin

1. Create a new user with the following values.

<table>
<thead>
<tr>
<th>User ID</th>
<th>Create an easily recognizable user name such as SOAPAUTH or SOAPONLY.</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>SOAP</td>
</tr>
<tr>
<td>Last name</td>
<td>Authentication</td>
</tr>
<tr>
<td>Password</td>
<td>Any password</td>
</tr>
</tbody>
</table>

2. Right-click the header bar and select Save. The record is saved, and the Related Lists appear.

3. In the Roles Related List, click Edit.

4. In the slushbucket, move the hthd_user role from the Collection list to the Roles list, and then click Save.

5. Navigate to System Definition > Help the Help Desk.

6. Add the user name and password you created to the appropriate properties, and then click Save. The password is encoded when saved.

   The login credentials from these properties are saved to the `helpthehelpdesk.js` script. When the Help the Help Desk script is run by a user logged in with these credentials (in the hthd_user role), the script is able to authenticate automatically on the instance.

**Help the Help Desk login script**

The Help the Help Desk script enables organizations to proactively scan their network to discover all Windows based hardware and the software packages installed on those devices.

This WMI-based script is included in the core ServiceNow platform functionality. This script also can be set up to run as a Windows login script and used to keep the CMDB up to date. The script is named `helpthehelpdesk.js` and can be downloaded from each customer's local instance.

**Install and use the login script**

The login script is installed on the instance and can be downloaded directly from a module.
Role required: admin

The same script is used to perform the Help the Help Desk scan, which gathers information about a user’s Windows computer and updates the CMDB.

1. Log in to your instance with Windows Internet Explorer.
2. Navigate to System Definition > Help the Help Desk Login Script.
3. Follow the download instructions in the page that appears.
4. Put the helpthehelpdesk.js file in the following folder: %SystemRoot%\sysvol\sysvol\<domain DNS name>\scripts where %SystemRoot% is usually c:\winnt or c:\WINDOWS and <domain DNS name> is the DNS name of the domain, similar to MyDomain.com. This folder is replicated to all domain controllers in the domain.
5. Open the helpthehelpdesk.js file in a text editor, such as Wordpad.
6. Check the var server line to ensure that the URL for your ServiceNow instance is correct.
The name of the instance is added automatically. It should look something like this:

```javascript
var server = "https://abctech.service-now.com/";
```

7. Ensure that basic authorization for SOAP requests is enabled in your instance, and a SOAP user is defined.
This allows the script to connect to your instance. The entry should look something like this:

```javascript
var httpUsername = "user_on_your_instance";
var httpPassword = "user's_password";
```

8. Create a Logon.bat script to run helpthehelpdesk.js as follows.

```bash
@echo off
cscript %0\helpthehelpdesk.js
EXIT
```

9. Add Logon.bat to the Logon script field on the Profile tab of the user properties dialog in the Active Directory Users and Computers MMC corresponds to the scriptPath attribute of the user object.
Logon scripts can also be configured in Group Policy. However, Group Policy only applies to clients with Windows 2000 or above. The setting in Group Policy is User Configuration, Windows Settings, Scripts (Logon/Logoff), Logon. Copy the file you want for the Logon script to the Windows clipboard.

10. Open the Logon setting in the Group Policy editor.

11. Click the Show Files button.
12. Paste the desired file in the dialog.
You can select the file and edit it in this dialog as well. This is easier than navigating in Windows Explorer to the folder where Group Policy Logon scripts are saved. However, if you do have to navigate to the folder, the path on the domain controller is:

%SystemRoot%\sysvol\sysvol\<domain DNS name>\<policy GUID>\user\scripts\logon

Again, %SystemRoot% is usually c:\winnt and <domain DNS name> is the DNS name of the domain, similar to MyDomain.com.

<policy GUID> is a hexadecimal string representing the GUID (unique identifier) of the specific Group Policy Object (GPO). Group Policies are assigned to a domain, site, or organizational unit in Active Directory.

The logon script setting applies to all users in the domain, site, or organizational unit to which the GPO applies. You will notice that you assign a logon script to all users in the container at once, rather than having to assign the scriptPath attribute for each user. This makes it much easier to assign logon scripts to many users. However, since the same Group Policy applies to all users in the domain, site, or organizational unit, you must code the logon script to accommodate all users.

Encode the Help the Help Desk password
You can use the Help the Help Desk properties to encode the password with simple base64 encoding.

Role required: admin

Configure the user name and encode the password in the properties before downloading the script. This adds the encoded password directly to the script without any further configuration.

1. Navigate to System Definition > Help the Help Desk.
2. Enter a user name and password into the properties for SOAP authentication.
3. Click **Save**.

**Customization Properties for Help The Help Desk**

SOAP authentication username for Help The Help Desk script.  

SOAP authentication password for Help The Help Desk script.  

For Discovery and Help the Help Desk, if the property is "yes", the "assigned_to" field of the CI is always overwritten; otherwise the field is not overwritten unless it is empty.  

Yes | No

For Discovery and Help The Help Desk, the following field in the sys_user table is used to associate a computer CI with a user.  

user_name

Save

The password is encoded immediately.

4. Navigate to **System Definition > Help the Help Desk Login Script**
5. Download the script.

```javascript
/* ************************* Required Variables *****************************
* The following section should be modified if the information is not correct.
***************************************************************************/

// The variable should point to your instance URL, such as https://demo.service-now.com
var server = "https://demo.service-now.com/

// If SOAP authentication is turned on on the instance. The http authentication should be provided here.
var httpUsername = "service-now-service:"
var httpPassword = "ec4w:ec4w4vswdsoQ";
```

The script downloads with the encoded password in place. If you download the script before encoding the password in the properties form, you must add the variable and encoded password manually.

### Run the Help the Help Desk script

You can run the Help the Help Desk script manually.

You also can configure Help the Help Desk to run automatically when users log into their computer. For more details, see Help the Help Desk login script.

1. On your instance, navigate to **Self Service > Help the Help Desk**.
2. Click **Start the Scan to Help the Help Desk**.
   You are prompted to run or save the discovery.hta script.
3. Run or save the discovery.hta script.
   - If your browser is Windows Internet Explorer, run the script.
   - If you are using any other browser, click **Save** and save the script to the local machine. To execute the saved script, double-click the file.

The script runs a series of WMI queries to gather information about the Windows machine. When it is finished, the data is sent back to your instance and is used to populate the configuration database (CMDB).

The error message **Error: Unable to parse SOAP document** means that the Help the Help Desk script was unable to connect to the instance to relay the information that was discovered.

### Run the discovery.hta script with browsers other than Internet Explorer

You can run the discovery.hta script with browsers other than Internet Explorer.

Browsers other than IE cannot handle files with the .hta extension. Browsers like Firefox, Safari, and Opera prompt users to download the script file, which you can then double-click to run.

However, in Windows XP (including Vista, Windows 2003 Server, and later), files downloaded from the Internet are marked with a security restriction that interferes with running the script. The typical error message introduced by this security restriction looks like this:

```javascript
eccEvent(): Access Denied
```
To remove the security lock on the downloaded file, complete the following steps.

1. **Right-click on the downloaded file and select** Properties.
   The following message is displayed on the bottom of the form: *This file came from another computer and may be blocked to protect this computer.*

2. **Click Unblock** to remove the security restriction.
   The script will run if SOAP authentication is disabled.

### Access Help the Help Desk status

Help the Help Desk displays the status of all scans in daily records. Drill down into a record for details on how the CMDB was updated within the last 24 hours from scans performed on the instance.

**Role required:** admin

1. **Navigate to** System Definition > Help the Help Desk Status.
   A new status record is created each day and displays the number of scans completed (devices scanned). The **Description** field shows Help the help desk as the source of the scan.

   ![Help the Help Desk status table]

   2. **To view the details of individual scans, open a scan record.**
   3. **In the scan record, select the Devices tab to view all the devices scanned by Help the Help Desk that day.**

   Each CI displays the device class and the activity completed: **Created CI** or **Updated CI**. By default, Help the Help Desk cannot discriminate class between servers and workstations and classifies each
CI as a **Computer**. However, if Discovery is activated on the instance, Help the Help Desk can classify CIs as either Windows servers or computers.

4. Select the **ECC Queue** tab to examine the data payload returned from each scan.

If Discovery is active on the instance, the Help the Help Desk status appears in the Discovery Status record list. These scan records are described as **Help the help desk** in the list to differentiate them from regular discoveries run from a schedule or a UI action. Open the status record to access the forms described in this page.
Determine values for the Assigned to field

This page explains how to set properties to determine which value appears in the Assigned to field when the script is run.

Role required: admin

Any user name that contains the \n characters prevents the Assigned to field on a computer from being populated.

- Navigate to System Definition > Help the Help Desk.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.wmi.assigned_to_always_overwrite</td>
<td>If the Help the Help Desk script is run on the same computer by different users, the platform overwrites the user name in the Assigned to field each time the script is run. To prevent this, set the For Help the Help Desk script, if the property is &quot;yes&quot;, the &quot;assigned_to&quot; field of the CI is always overwritten; otherwise the field is not overwritten unless it is empty [glide.wmi.assigned_to_always_overwrite] property to false (clear the check box).</td>
</tr>
<tr>
<td>glide.discovery.assigned_user_match_field</td>
<td>Help the Help Desk attempts to match a Windows user name it finds with the the user_name field of the User [sys_user] table. However, this might not be desirable if the user_name field from the User [sys_user] table contains formatting that is different from that found in Windows. The For Discovery and Help the Help Desk, the following field in the sys_user table is used to associate a computer CI with a user [glide.discovery.assigned_user_match_field] property enables you to select an alternative field for matching. For example, you can create a field called u_username, and then populate it with a user ID that can be matched against the Windows user name. In this case, replace the default value in the property with u_username.</td>
</tr>
</tbody>
</table>

View scan results

You can view the results of Help the Help Desk scans on an instance.

Role required: admin

These records provide access to logs, CI records, and the ECC Queue for all scans conducted each day. Help the Help Desk status reports are also accessible from the Discovery list.

1. Navigate to System Definition > Help the Help Desk Status.
2. Open the daily status record.

Help the Help Desk script troubleshooting

With the Help the Help Desk script, you can detect all system software on a 64-bit machine. You can also configure the Help the Help Desk script to run for users without prompting for a user name and password.
**Allow users without a ServiceNow instance login to run Help the Help Desk script**

You can configure the Help the Help Desk script to run for users without prompting for a user name and password.

Role required: admin

This setup enables users who do not have access privileges to an instance to run the script on their Windows machines without having to provide a user name and password. The script can be configured to login in automatically as a SOAP user with the hthd_user role.

1. Log in to your instance with Windows Internet Explorer.
2. Navigate to **System Definition > Help the Help Desk Login Script**.
3. Follow the download instructions in the page that appears.
4. Put the helpthehelpdesk.js file in the following folder: `%SystemRoot%\sysvol\sysvol\<domain DNS name>\scripts` where `%SystemRoot%` is usually `c:\winnt` or `c:\WINDOWS` and `<domain DNS name>` is the DNS name of the domain, similar to MyDomain.com.
   This folder is replicated to all domain controllers in the domain.
5. Open the helpthehelpdesk.js file in a text editor, such as Wordpad.
6. Check the var server line to ensure that the URL for your ServiceNow instance is correct.
   The name of the instance is added automatically. It should look something like this: `var server = "https://abctech.service-now.com/"`

```javascript
/* *************** Required Variables *******************
* The following section should be modified if the information is not correct.
* ******************************************

// The variable should point to your instance URL, such as http://demo.service-now.com
var server = "https://abctech.service-now.com";

// If SOAP authentication is turned on on the instance. The http authentication should be provided here
var httpUsername = "";
var httpPassword = "";

/* *************** Optional Variables *******************
* The following section can be modified for other purposes.
* ******************************************
```

7. Ensure that basic authorization for SOAP requests is enabled in your instance and a SOAP user is defined.
   This allows the script to connect to your instance. The entry should look something like this:

```javascript
var httpUsername = "user_on_your_instance";
var httpPassword = "user's_password";
```

8. Make the script file available to all users.

**Detect software on 64-bit systems with Help the Help Desk**

You can detect all system software successfully on a 64-bit machine.

A 64-bit browser can detect both 64-bit and 32-bit software, but a 32-bit browser cannot detect 64-bit software.

- To detect all system software, run the Help the Help Desk script from a 64-bit browser.
Enterprise CMDB

The Enterprise Configuration Management Database (ECMDB) is targeted toward businesses that want to monitor, manage, measure, track, alert on change, and generally understand business systems that consist of a large number of components, business, and support personnel.

For example, a bond trading service may have multiple application, and web servers, several databases, Linux, UNIX, and Windows servers. There will be security products, network storage, disaster recovery procedures and hardware, etc. that are necessary for the service to operate properly.

The ECMDB makes it easy to either manually enter the relationships or have them populated automatically by discovery tools. In addition to the hardware, software, network, database, and storage areas, it is beneficial to know which individuals or groups are responsible for the service from both a business perspective as well as an IT perspective. Who are the line of business users and managers? Who starts and stops the application or its components? Who monitors the log files? Who is in charge of backup and restore, business continuity, and disaster recovery?

Enterprise CMDB is available with the Configuration Management (CMDB Enterprise Edition) (com.snc.cmdb.enterprise) plugin, which is active in the base system.

CMDB Relationships

The ECMDB lets you easily track all relationships by relationship type.

The Enterprise CMDB extends the capabilities of the ServiceNow platform CMDB in the following areas.

Extended configuration item types

- Clusters
- Database Instances (Oracle, MySQL, MSFT SQL Server)
- File Systems (Direct and network attached)
- Linux Servers
- Solaris Servers
- AIX Servers

Extended relationships

Accurate description of relationships between items, and between items and people or groups, is important to understand the fabric of a business service. ECMDB provides many relationship types out of the box, but it is easy to extend the number of relationship types. Example relationship types include the following.

- Connects to
- Depends on / Provides Service to
- Powered by / Powers
- Protected by / Protects
- Disaster Recovery Provided by / Provides Disaster Recovery for

Visualization

The system can show relationships as a hierarchy using a standard treenview, flattened, or graphically, all in a simple web interface.
Auditing

Auditing of changes to configuration items is turned on by default.

Federation

Federation of third party discovery and configuration data is supported through standard synchronization offerings (SMS, LAN Desk, others) and through the CMDB Discovery [cmdb_discovery] table.

Configuration item modeling (product models)

Model driven configuration management allows the definition of CI models up front that can be associated to product maintenance lifecycles, cost centers, and support organizations, as well as provides a means for capacity and inventory planning. By defining models for CIs (which have a many to one relationship to the model), you can dynamically group actual discovered or imported CIs into logical, operational, and financial models. This facilitates an organized approach to managing your assets (CIs) in their respective domains.

Enterprise Configuration Management Database (ECMDB) action icons

Any of the following icons may appear in the ECMDB lists of related items.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>For currently active incidents against this configuration item</td>
</tr>
<tr>
<td>🔄</td>
<td>For currently active problems against the configuration item</td>
</tr>
<tr>
<td>🔄</td>
<td>For currently active changes against the configuration item that are not covered in the past, current, pending changes. For example, a request to update the operating system on a server that is currently in progress may display this icon.</td>
</tr>
<tr>
<td>🔴</td>
<td>For changes that were recently completed against the configuration item. Changes with an &quot;Actual_end_date&quot; in the past.</td>
</tr>
<tr>
<td>🔴</td>
<td>For changes that are planned soon against the configuration item. Changes with an &quot;Actual start date&quot; in the future.</td>
</tr>
<tr>
<td>🔴</td>
<td>For currently active changes against the configuration item that have an &quot;Actual start date&quot;</td>
</tr>
<tr>
<td>🟢</td>
<td>For outages that were recently completed against the configuration item. Outages with an &quot;end&quot; date in the past.</td>
</tr>
<tr>
<td>🟢</td>
<td>For outages that are planned soon against the configuration item. Outages with a &quot;begin&quot; date in the future.</td>
</tr>
<tr>
<td>🔴</td>
<td>For currently active outages against the configuration item that have a &quot;begin&quot; date in the past and no &quot;end&quot; date</td>
</tr>
</tbody>
</table>
This will only show up in the Tree view and indicates that a configuration item that is downstream has at least one of the above issues against it.

The system looks 5 calendar days in the past and 7 calendar days in the future when looking at recent outages and changes.

**Business service tables**

In the CMDB, the Service table [cmdb_ci_service] stores information about business services.

A business service is work or goods that are supported by an IT infrastructure. For example, delivering email service to an employee can require services such as email servers, web servers, and the work to configure the user's account. A business service management map graphically displays the configuration items (CI) that support a business service and the relationships between the configuration items.

The Service table [cmdb_ci_service] stores the business services in the CMDB.

**The Service table**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business criticality</td>
<td>The importance of this service to the business. This field can be used to determine disaster recovery strategies for this service. Default options are:</td>
</tr>
<tr>
<td></td>
<td>• 1 - most critical</td>
</tr>
<tr>
<td></td>
<td>• 2 - somewhat critical</td>
</tr>
<tr>
<td></td>
<td>• 3 - less critical</td>
</tr>
<tr>
<td></td>
<td>• 4 - not critical</td>
</tr>
<tr>
<td>Service classification</td>
<td>Designates the type of the service.</td>
</tr>
<tr>
<td></td>
<td>• Business Service (For more information, see Application services)</td>
</tr>
<tr>
<td></td>
<td>• Technical Service (For more information, see #unique_351)</td>
</tr>
<tr>
<td></td>
<td>• Service Offering (For more information, see Service offerings)</td>
</tr>
<tr>
<td></td>
<td>• Shared Service (For more information, see #unique_353)</td>
</tr>
<tr>
<td></td>
<td>• Application Service (To represent a service that is classified as a business application)</td>
</tr>
<tr>
<td></td>
<td>• Billable Service (To represents a service that is billed, or that is cost managed)</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Used for</td>
<td>Designates how this service is used. Default options are:</td>
</tr>
<tr>
<td></td>
<td>• Production</td>
</tr>
<tr>
<td></td>
<td>• Staging</td>
</tr>
<tr>
<td></td>
<td>• QA</td>
</tr>
<tr>
<td></td>
<td>• Test</td>
</tr>
<tr>
<td></td>
<td>• Development</td>
</tr>
<tr>
<td></td>
<td>• Demonstration</td>
</tr>
<tr>
<td></td>
<td>• Training</td>
</tr>
<tr>
<td></td>
<td>• Disaster Recovery</td>
</tr>
<tr>
<td>Users supported</td>
<td>The users that this service supports.</td>
</tr>
<tr>
<td></td>
<td>A reference to the Group [sys_users_group] table.</td>
</tr>
<tr>
<td>Version</td>
<td>Use this field for your own versioning processes.</td>
</tr>
</tbody>
</table>

**The Service Configuration Item Association table**

The Service Configuration Item Association table [svc_ci_assoc] binds a business service and a configuration item (CI) to track which CIs are part of each business service.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item Id</td>
<td>A reference to the Configuration Item [cmdb_ci] table.</td>
</tr>
<tr>
<td>Service Id</td>
<td>A reference to the Service [cmdb_ci_service] table.</td>
</tr>
</tbody>
</table>

**The Service Relationship Association table**

The Service Relationship Association table [svc_rel_assoc] binds a business service and a relationship to track which relationships are part of a business service.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relation Id</td>
<td>A reference to the CI Relationship [cmdb_rel_ci] table.</td>
</tr>
<tr>
<td>Service Id</td>
<td>A reference to the Service [cmdb_ci_service] table.</td>
</tr>
</tbody>
</table>

**Table form views**

When you view a table definition form, you can open the context menu, and select a form view in which to display the table. The default view for a table is the Default view. For any class that is an extension of the CMDB table, you can select the CI Definition view which provides additional access to related tables and information.
The CI Definition form view is a centralized location from which you can configure and view a table. In addition to the information that the default view displays, the CI Definition form view provides the following controls,

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon tab</td>
<td>View and create new NG-BSM icons for CI types</td>
</tr>
<tr>
<td>CI Identifier tab</td>
<td>View and create new CI identifiers</td>
</tr>
<tr>
<td>Reconciliation Definitions tab</td>
<td>View and create new data source definitions</td>
</tr>
<tr>
<td>Inclusion related link</td>
<td>Links to the Metadata Editor</td>
</tr>
</tbody>
</table>

To access these additional controls on the CI Definition form view, you need to first create a new table that is derived from the CMDB table, and then view it using the CI Definition form.

**Out-of-the-box Configuration Management (CMDB) Performance Analytics Solutions**

Performance Analytics solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from for your application with minimal setup.

**Important:** Set up and test Out-of-the-box Solutions on a sub-production instance before enabling them in production.

**Note:**
- Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.
- Out-of-the-box solutions and in-form analytics provide all the configuration records required to analyze default applications. Customize these records for use in your production environment.

To enable the solutions for Configuration Management (CMDB), an admin can navigate to **Performance Analytics > Guided Setup**. Click **Get Started** then scroll to the section for Configuration Management (CMDB). The guided setup takes you through the entire setup and configuration process.

**Dependency Views**

ServiceNow® Dependency Views graphically displays an infrastructure view for a configuration item (CI) and the application or business services that it is part of and that it supports. Dependency Views indicates the status of its configuration items, and allows access to CIs related alerts, incidents, problems, changes, and services.

If Service Mapping is activated, Dependency Views maps are enhanced to display dependencies that reflect connections in service maps.
Supported browsers for Dependency Views

The latest version or service pack of internet browsers are required to view and manipulate Dependency Views maps.

The Dependency Views module supports the latest version or service pack of the following browsers:

- Firefox with the latest ESR
- Chrome latest version
- Safari version 8 or later (latest is recommended)
- Microsoft Internet Explorer (IE) version 11 and Microsoft Edge.

The Dependency Views module is not supported on tablets and on mobile devices.

Domain separation and Dependency Views

This is an overview of domain separation in Dependency Views. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Support: Level 1

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

How domain separation works in Dependency Views

Dependency views are generated using both Configuration Item [cmdb_ci] and CI Relationship [cmdb_rel_ci] tables. The [cmdb_ci] table is domain separated, but the [cmdb_rel_ci] table is not. You can create relationships only by selecting two CIs. They should be in the same domain for you to be able to see them.
To be successful with domain separation in Dependency Views, make sure that relevant CIs are visible for the current domain. If the instance is domain separated, ServiceNow domain separation rules apply (see Related information link below).

Tenant domains will be able to see only their domain and global CIs.

**Dependency Views map**

ServiceNow® Dependency Views maps graphically display CIs that support application or business services and the relationships between the CIs.

A ServiceNow service (application service or business service) is work or goods that are supported by an IT infrastructure. For example, delivering email service to an employee can require services such as email servers, web servers, and the work to configure the user’s account.

A Dependency Views map has one starting point, called the root CI or root node of the map. The root CI is surrounded by a darker frame that repaints itself with a pulsing effect drawing the attention to the root CI. The maps can show both upstream and downstream dependencies for the root CI. By default the Dependency Views map displays 3 levels, both upstream and downstream relationships. Administrators can configure the number of levels displayed. The map collapses and expands clusters to make them easier to view. By default, clusters are collapsed.

In a Dependency Views map, map indicators indicate if a CI has any active, pending issues. You can investigate the tasks that are connected to a CI to get more details. When you return to the map from another form, the system restores the last map viewed, using the default filter and layout settings. When you click the icon

( ![ ] )  

on a CI record or on a task record that identifies a CI, the map opens.

Many of the relationships in map are created through the discovery process. You can also create, define, and delete CI relationships in the map. You can display the map from different perspectives and open specific records that relate to configuration items. The system refreshes the map automatically to reflect changes to the CMDB.

**Note:** CIs not extended from the Configuration Item [cmdb_ci] table, are not displayed in Dependency Views maps and in CI relation formatters.

The Dependency Views module is active in all instances, and includes demo data.
Dependency Views sample map

When you click the map icon

[ ]
on a CI record or on a task record that identify a CI, a map opens.

Roles

Users with the itil and ecmdb_admin roles can view maps and perform all actions in the map. Actions include access to the map views and saved filters, both from the lists in the map and from theSaved Filters module.

Dependency Views map menus and controls

Dependency Views maps contain the following menus and controls.
## Map options

The following options are available across the top of the map.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>Menu to save, load and export views of the map.</td>
</tr>
<tr>
<td>&lt;Root CI&gt;</td>
<td>Next to the menu icon is the name of the current root node (CI) of the map.</td>
</tr>
<tr>
<td>Search</td>
<td>Enter the name of a CI, application service, or business service to load into the map. Alternatively, you can start typing to have the auto-complete feature present a list of CIs and services that match your partial value.</td>
</tr>
<tr>
<td>Vertical</td>
<td>Display the map in vertical view.</td>
</tr>
<tr>
<td>Horizontal</td>
<td>Display the map in horizontal view.</td>
</tr>
<tr>
<td>Radial</td>
<td>Display the map in radial view.</td>
</tr>
<tr>
<td>Force</td>
<td>Centers the elements around the parent CI, regardless of upstream or downstream relationships.</td>
</tr>
<tr>
<td>Group</td>
<td>Groups the elements according to their CI type.</td>
</tr>
<tr>
<td>Details</td>
<td>Displays related lists such as Problems, Changes and Related Services that are associated with the selected CI.</td>
</tr>
<tr>
<td></td>
<td>• Click a service to highlight the CIs that are associated with that service.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Related Services</strong>, then double-click a service to display the map in the Event Management dashboard.</td>
</tr>
<tr>
<td></td>
<td>If the Event Management plugin is active, then events and alerts are also displayed.</td>
</tr>
<tr>
<td>Settings</td>
<td>Set filters for the map.</td>
</tr>
<tr>
<td>Use the navigation tools to increase or decrease the view of the map, rearrange the icons on the map, and move the map on the page.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Use the plus sign (+) to increase magnification of the map.</td>
</tr>
<tr>
<td></td>
<td>• Use the minus sign (-) to decrease magnification of the map.</td>
</tr>
<tr>
<td></td>
<td>• Click the center dot to center the map on the page.</td>
</tr>
<tr>
<td></td>
<td>• Use the direction arrows to move the page in that direction.</td>
</tr>
<tr>
<td></td>
<td>• Use the selection tool under the navigation tool to toggle between moving the entire map or moving one CI on the map.</td>
</tr>
</tbody>
</table>
### Map menu

The following options are available if you right-click the map background.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Layout</td>
<td>Redraws the map with the current layout option.</td>
</tr>
<tr>
<td>Fit To Screen</td>
<td>Resizes the map to fit all the nodes in the map window.</td>
</tr>
<tr>
<td>Reset Filters</td>
<td>Performs the same action as the Filters &gt; Reset option.</td>
</tr>
</tbody>
</table>

### Node menu

The following options are available if you right-click a node.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Form</td>
<td>Displays the CMDB record of the selected CI in a new tab of the browser.</td>
</tr>
<tr>
<td>View Map</td>
<td>Reloads the map using the selected CI as the new root node, with the currently defined layout setting. This option does not display on the root node.</td>
</tr>
<tr>
<td>View Related Tasks</td>
<td>Displays all tasks or outages associated with the selected CI, including incidents, problems, change requests, and follow-on tasks. This option is always available, even if there are no tasks associated with the CI. This option does not appear on collapsed nodes.</td>
</tr>
<tr>
<td>View Affected CIs</td>
<td>Shows a list of all tasks that have the CI listed as an Affected CI. This option is only visible when you access the map from the map icon in a task record's Configuration item field.</td>
</tr>
<tr>
<td>View Related Outages</td>
<td>Displays all outages involving the selected CI. This option only appears when there is an outage associated with the CI. This option does not appear on collapsed nodes.</td>
</tr>
<tr>
<td>Add Relationship</td>
<td>This option displays a dotted green line that you can drag to another CI to create a relationship link. A popup dialog allows you to define the relationship type.</td>
</tr>
<tr>
<td>Expand</td>
<td>Displays all CIs and components within a clustered node, or virtual groups (virtual nodes that appear when glide.bsm.too_many_children is reached). This option appears only if the node is a cluster node or a virtual group node. If Load More was previously used, then Expand reverts the results of the Load More operation. The number of additional icons to display is bound by the value of the glide.bsm.max_nodes property.</td>
</tr>
</tbody>
</table>
Collapse

Collapses all CIs and components within a cluster node back to a single node. Also, collapses a virtual group that has been expanded. This option only appears if the node has been expanded using the Expand menu item.

If Load More was previously used, then Expand reverts the results of the Load More operation.

Run Layout From Here

This option re-runs the chosen layout using the current node. Use this option to get a new or clearer view on the same map.

Load More

Starting at the selected icon, loads the next level of the map, past the setting of Max Levels.

Virtual grouping is not applied at the newly loaded level even if the criteria for virtual grouping is met.

The number of additional icons to display is bound by the value of the glide.bsm.max_nodes property.

Relationship menu

The following options are available if you right-click a relationship link.

View Relationship Form

Opens the CI Relationship form. You can modify the Parent, Type, and Child of the relationship from this form.

Modify Relationship

Searches for and selects a new relationship for this link.

Delete Relationship

Deletes a relationship. The relationship is deleted after prompting for confirmation.

Cluster nodes in a Dependency Views map

Dependency Views maps can display cluster group nodes alongside individual CI nodes, and the child nodes of these cluster groups.

Clusters are CIs in the Cluster [cmdb_ci_cluster] table. A cluster CI is an organized set of computer CIs that work together as a single system. Each node in a cluster group represents a CI, typically a server, that can have referenced hardware, such as disks and network adapters.

Cluster nodes on a Dependency Views map can display in two modes:

- Collapsed mode: Displays only the cluster CI node without its child CI nodes. This mode avoids unnecessary clutter in large maps.
- Expanded mode: Displays the cluster CI node and all its child CI nodes.

Menu options available for a clustered node include Collapse and Expand which allow you to control the density on the map.

By default, Dependency Views collapses all cluster groups and displays clusters in collapsed mode on the map.
Annotation

Icons for cluster nodes and cluster group CI nodes are noted by the string "Cluster" and by a unique cluster icon. The system searches through all the component nodes in a cluster CI or collapsed node looking for tasks, outages, and trouble, such as incidents, problems, or change requests. This search evaluates only the number of levels that are displayed in the diagram.
An expanded cluster node displaying its child nodes
Virtual grouping of nodes in a Dependency Views map

To reduce the density on a map, Dependency Views automatically groups CIs of a similar CI type from the same level.

A large number of nodes can cause a Dependency Views map to become too dense to be helpful. Therefore, if the number of nodes with a similar CI type from same level, exceeds the value of the **Maximum number of nodes (of a similar CI type and at the same level) to display before applying virtual grouping** property, then those nodes are automatically grouped into a virtual group. A single node, the **virtual group node** is displayed to represent the virtual group, while all actual nodes in the virtual group (that are of a similar CI type), are hidden. Virtual group nodes represent CIs of a similar CI type but are not CIs by themselves and cannot have tasks assigned to them. The number of actual collapsed nodes in the virtual group is noted on the virtual group node.

By default, child nodes of a virtual group are not displayed. You can enable the **Show children of virtual groups** property to display child nodes underneath virtual groups.

Virtual grouping is not applied at the level underneath a virtual group even if the criteria for virtual grouping is met (the number of nodes with a similar CI type from that level exceeds the preconfigured property value). However, virtual grouping can happen at the following level if that criteria is met. This behavior does not depend on any property settings, and you cannot change it.

Menu options for a virtual group include Expand and Collapse, which allow you to apply virtual grouping and display only the virtual group node, or to undo the virtual grouping and display all actual nodes.

**Virtual links**

A virtual node is connected to other nodes with a virtual link. A virtual link denotes that there such link between at least one CI in the virtual group, to another CI node on the map.

**Note:** All filters do not apply to virtual groups. Therefore a virtual group displays even if it contains CIs that a filter would have excluded. Upon the expansion of a virtual group, predefined filters are applied, and any or all of the CIs that were previously virtually grouped, might no longer display on the map.

Also, when using the node menu option Load More, virtual grouping is not applied at the newly loaded level even the criteria for virtual grouping is met.
An expanded virtual group
Use Dependency Views

Use the layout controls on a Dependency Views map to display elements in different configurations for easier management. Use the filter panel on the map to display fewer levels or to filter out elements you don't want to see, then save the filter for use later. Draw new relationships between elements or edit existing relationships.

View a Dependency Views map

When you display a Dependency Views map using one of the options below, the map is centered on the root CI, and displays the layout and number of levels defined in the map properties. If Operational Intelligence is activated, then a Dependency Views map provides a mode that lets you directly access metrics information for the CIs on the map.

General role requirements:

• To access a Dependency Views map from either the navigation menu, a script API, or directly from a URL, the minimum role required is the dependency_views. Some operations that are related to icons, indicators, and menu actions require the ecmdb_admin role. Some operations that are related to properties and dependency types require the admin role.
• Dependency Views enforces ACL permissions on CIs, and visually hides them and their relationship from the map if the permission requirement is not met.

The maps generated by Dependency Views are based on D3 and Angular technology, providing a modern interactive graphical interface to visualize configuration items and their relationships.

If Service Mapping is activated, Dependency Views maps are enhanced to display dependencies that reflect connections in service maps. In addition, the list of related services in the Details section, includes application services, and technical and manual services if Event Management is activated. All CIs that are included in a service, are displayed underneath the service node on the map.

Maps provided by Service Mapping are for application services, including comprehensive maps from the perspective of application services. For more information, see Service Mapping.

Administrators can configure the setting for the default layout of the map and number of levels displayed. When you access the map from a saved view, the map opens using the properties in the saved view, and not the default map properties.

Navigate to Dependency Views and open one of these modules:

• View Map in New Tab: Opens the map in a new, full screen tab without the application navigator.
• View Map: Opens the map in the content pane of the current tab.
• Saved Views: Opens a view of a map that you previously saved.

Click a number in the Version column, and then click the

( ) icon.

Save or load a Dependency Views map

In the View Map module, use the menu icon to save and load Dependency Views maps.

1. Navigate to Dependency Views > View Map.
2. Click the view menu icon

( )

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
3. Select Save View, Load View, or Last View.

Delete a saved Dependency Views map view
Use the Saved Views module to delete a previously saved view.
1. Navigate to Dependency Views > Saved Views.
2. Use the checkbox in the first column of the table to select the map view that you wish to delete.
3. Select Delete from the Actions on selected rows drop-down menu.

Change the layout of Dependency Views map
You can select from different layout options for your Dependency Views map.
1. Navigate to Dependency Views > View Map.
2. Select one of the following layout options from the menu across the top of the view.
   • Vertical: Displays the elements in a vertical tree pattern according to their upstream and downstream relationships. This is the default value for the initial display of the map.
   • Horizontal: Displays the elements in a horizontal tree pattern according to their upstream and downstream relationships.
   • Radial: Displays the elements in a radial pattern according to their upstream and downstream relationships.
   • Force: Centers the elements around the parent CI, regardless of upstream or downstream relationships.
   • Group: Groups the elements according to their CI type.
   • Details: Displays related alerts, incidents, problems, and related services.

   Related Services displays application services, and if Event Management is activated then also technical services and manual services. You can double-click a service to display the map in the Event Management dashboard.

Filter the view of a Dependency Views map
You can filter a Dependency Views map to display specific types or categories of configuration items.
Use the filter panel to control which elements of the map are displayed and to save versions of a filter for later use.
1. Navigate to Dependency Views > View Map.
2. Click the button to open Map Settings. Click a filter strip to expand or collapse it, and to set filter items.

<table>
<thead>
<tr>
<th>Filter panel strips and options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Custom Settings</td>
<td>Configure desired custom settings, then enter a name and click Save.</td>
</tr>
<tr>
<td></td>
<td>Custom settings can be loaded by using the Load Saved Custom Settings option.</td>
</tr>
<tr>
<td></td>
<td>Navigate to Dependency Views &gt; Saved Settings &gt; to display all saved custom settings.</td>
</tr>
<tr>
<td>Filter panel strips and options</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Load Custom Settings</td>
<td>Apply previously saved custom settings to the current map.</td>
</tr>
<tr>
<td>Predefined Filters</td>
<td>Apply previously defined filters consisting of configuration type, CI type, and relationship filters. You can Set a predefined filter as default. This filter is applied first, before any other filters (such as Filter CIs by Depth) are applied.</td>
</tr>
<tr>
<td>Dependency Type</td>
<td>Apply a filter that runs in real time and generates a custom view of a service map for a specific CI.</td>
</tr>
<tr>
<td>Max Levels</td>
<td>Designate how many levels from the root CI display on the map.</td>
</tr>
<tr>
<td>Filter CIs by Depth</td>
<td>Designate which levels of CI display on the map.</td>
</tr>
<tr>
<td>Filter CIs by CI Type</td>
<td>Designate what CI types display in the map.</td>
</tr>
<tr>
<td>Filter CIs By CI Location</td>
<td>Designate what CI locations display in the map.</td>
</tr>
<tr>
<td>Filter CIs By CI Manufacturer</td>
<td>Designate what CI manufacturers display in the map.</td>
</tr>
<tr>
<td>Filter CIs By Audit Failure</td>
<td>Hides CIs that failed the CMDB health staleness test. This option is available only if there are any such CIs.</td>
</tr>
<tr>
<td>Filter Relationship Types</td>
<td>Designate what relationship types display in the map.</td>
</tr>
<tr>
<td>Map Indicators</td>
<td>Designate what types of tasks display and get counted in the map.</td>
</tr>
<tr>
<td>Remove Filtered Items</td>
<td>Off: Gray out filtered items on the map.</td>
</tr>
<tr>
<td>Run Layout Automatically</td>
<td>Off: Do not display filtered items on the map.</td>
</tr>
<tr>
<td>Fit to Screen Automatically</td>
<td>On: The configured layout to the map is reapplied whenever the filter is changed.</td>
</tr>
<tr>
<td></td>
<td>Off: The map layout remains static when the filter is changed.</td>
</tr>
</tbody>
</table>

**View metrics for CIs in a Dependency Views map**

Operational Intelligence processes metrics data for CIs, calculates statistics and aggregations, and detects metrics anomalies. A Dependency Views map lets you switch to metrics mode to directly access the Insights Explorer that displays metrics data for CIs on the map.

The Operational Intelligence (com.snc.sa.metric) plugin must be activated to enable this functionality, and metrics data needs to be processed for the CIs on the Dependency Views map.

Open a Dependency Views map in metric mode which integrates a Dependency Views map with the Insights Explorer functionality that is tailored to the map. In this mode, you can access Insights Explorer...
functions directly from the map, to explore metrics data for the CIs on the map. All map CIs are accessible in the right hand side pane, from where you can drill into metrics data.

1. Navigate to **Dependency Views > View Map** to open a map.

2. Right-click on a CI on the map and select **View Metrics** to open the Dependency View map in metrics mode.

   In the panel on the right side, the CI that you selected on the Dependency View map is selected by default, and the list of all the metrics available for that CI are displayed.

3. Click the ‘<’ sign on the left of the CI to display all the CIs that you can explore metrics for.

   The Insights Explorer is scoped for exploring only the CIs that currently display on the Dependency Views map, and you cannot add or remove CIs from the list. If you use map settings or filters to filter out CIs from the map, the same filtering will apply to the list of CIs that you can explore metrics for.

4. Click on a CI in the CIs list or right-click on a CI on the Dependency Views map, to drill down to the CI’s metrics.

5. Click the **Dependencies Map** tab or the **Metrics** tab to switch modes:

   a) In **Metrics** mode: The full functionality of the Insights Explorer is available, you can create metric charts by dragging metrics into the canvas. You can modify chart settings, select different time ranges for the charts, and perform other actions as described in View metric values in the Insights Explorer.

   b) In **Dependencies Map** mode: Select a CI on the map to drill down to its metrics data, drop-down the **Layout** list to choose a different layout, or modify map settings.

**Perform actions on nodes in a Dependency Views map**

You can view various related items for the nodes in a Dependency Views map.

If the node is a collapsed node or represents a cluster, the incidents, problems and change requests are for all the collapsed nodes.

1. Navigate to **Dependency Views > View Map**.

2. Click the

   ![icon] icon next to a node or right-click a node on the map, to access the following menu items:

   **Node Menu**

<table>
<thead>
<tr>
<th>View Form</th>
<th>Displays the CMDB record of the selected CI in a new tab of the browser.</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Map</td>
<td>Reloads the view using the selected CI as the new root node, with the currently defined layout setting. This option does not display on the root node.</td>
</tr>
<tr>
<td>View Related Tasks</td>
<td>Displays all tasks or outages associated with the selected CI, including incidents, problems, change requests, and follow-on tasks. This option is always available, even if there are no tasks associated with the CI. This option does not appear on collapsed nodes.</td>
</tr>
<tr>
<td>View Affected CIs</td>
<td>Shows a list of all tasks that have the CI listed as an Affected CI. This option is only visible when you access the view from the view icon in a task record's Configuration item field.</td>
</tr>
</tbody>
</table>
### Export a Dependency Views map

You can export a Dependency Views map to an image in PNG format.

1. Navigate to **Dependency Views** > **View Map**.
2. Configure the map view as you want the image to appear. The exported image displays the current view of the map.
3. Click the view menu icon

   ![View Menu Icon](image)

4. Click **Export Image**.
5. Right-click the image and select **Save Image As**, **Print**, or any other menu option.

   **Note**: You can not export images from a Dependency Views map using Internet Explorer as your browser.

6. Click the "X" button to close the **Export Image** window.
View collapsed nodes in a Dependency Views map

Cluster and virtually grouped nodes can be displayed in a collapsed mode to avoid unnecessary clutter in large maps.

1. To expand a collapsed node, right-click the CI and select **Expand** from the context menu.
2. To collapse an expanded cluster node with children, right-click the CI and select **Collapse** from the context menu.

Administer Dependency Views

Users with the admin role can control the appearance and behavior of Dependency Views by configuring map indicators, map related items, map icons, and menu actions.

Create or modify map indicators

Dependency Views maps and application service maps, use icons to display additional information for a CI by displaying its related records such as alerts, outages, incidents and problems. These icons are called **map indicator**.

The default configuration includes map indicators for the following record types:

- Open incident.
- Open alert.
- Unplanned current outage.
- Planned current outage, or an open problem.
- Current, planned, or recent change request.

You can filter out the display of affected CIs, alerts, current change requests, incidents and problems from the map settings menu. Also, you can create a map indicator to define additional record types, such as trouble sources for CIs in a service. You can also modify an existing map indicator, for example to use a different color scheme or to alter the priority of a task.

The Affected CI’s map indicator appears for CIs in two related but not identical situations. It appears for CIs for which tasks such as change request, incident, or problem were directly created for, and for any CIs that were added in those tasks (parent tasks) as Affected CIs (The CI for which a task is directly created for, is automatically added as an affected CI in that task). The state of affected CI’s depends on the status of the respective parent task. For as long as the parent task is active, the associated affected CIs continue to be impacted by the task issue. In a map, the Affected CI’s indicator displays for all affected CIs for as long as the parent task is active. On a map, the Affected CI tooltip displays the details of the task records in which the CI was added as an affected CI. However, the **Details** pane does not contain an Affected CI’s tab, and no further details about affected CIs, or the associated tasks are displayed. After the parent task is closed, the Affected CI’s indicator no longer displays for any of the tasks’ affected CIs. For information about affected CIs in Change Management, see **Associate CIs to a change request**.

**Note:** Details about affected CIs are derived from the **task** and the **cmdb_ci** tables and their extensions. Therefore, if you use custom tables to store CIs for incidents, problems and changes, it affects the details that are displayed for affected CIs.

For more information on how map indicators are used to show tasks and outages in clusters and collapsed nodes, see **Cluster nodes in a Dependency Views map**.

1. Navigate to **Dependency Views > Map Indicators**.
2. Click **New** to create a new map indicator, or click the name of an indicator from the **Table** column to modify an existing map indicator.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
3. Fill in the fields on the form, as appropriate.

**Map Indicator form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Name of the table represented by this map indicator. <strong>Note:</strong> The list shows only tables and database views that are in the same scope as the map indicator. Views are not supported, although included in the list.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the indicator.</td>
</tr>
<tr>
<td>Order</td>
<td>Priority order of the task. The highest priority task is the indicator with the lowest order number. When more than one indicator is present on a CI, the displayed color is the color associated with the highest priority task. Additionally, a glyph on a CI displays the color indicator of the highest priority task attached to that CI.</td>
</tr>
<tr>
<td>Icon</td>
<td>File name and path of the icon image file, which can be a system image. • To create a new icon, see Create or modify map icons • To create or use a system image see Storing images in the database.</td>
</tr>
<tr>
<td>CMDB CI field</td>
<td>Name of the field on the selected table that contains the configuration item.</td>
</tr>
<tr>
<td>Start field</td>
<td>The record property that determines the time-point on the metric chart timeline for placing records in the Insights Explorer. Possible values depend on the selected Table. For example, the incident indicator has values such as Actual end, Actual Start, and Approval Set.</td>
</tr>
<tr>
<td>Description field</td>
<td>Name of the field on the selected table that contains the description of the configuration item.</td>
</tr>
<tr>
<td>Description</td>
<td>Text to display when hovering over the indicator. Alphanumeric characters and spaces are valid for this field.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Condition builder that specifies for which CIs to apply this indicator. For example, a CI that has a current past outage is highlighted for 5 days. You can configure a condition to designate a different timeframe for what is considered to be current.</td>
</tr>
<tr>
<td>Active in Service Map</td>
<td>Enable to make the toggle for the specified table available in the Settings dialog box for application service maps. You can then toggle between displaying or not displaying the respective records on the map.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active Dependencies</td>
<td>Enable to make the toggle for the specified table available in the Settings dialog box for Dependency Views maps. You can then toggle between displaying or not displaying the respective records on the map.</td>
</tr>
<tr>
<td>Active in Metrics</td>
<td>Enable to make the toggle for the specified table available in the Settings dialog box for the Insights Explorer. You can then toggle between displaying or not displaying the respective records on the Insights Explorer.</td>
</tr>
<tr>
<td>Label</td>
<td>Text to display for the indicator on the map.</td>
</tr>
<tr>
<td>Tooltip Label</td>
<td>The prefix portion of the tooltip (Tooltip Label : Tooltip info).</td>
</tr>
<tr>
<td>Tooltip Info</td>
<td>The suffix portion of the tooltip (Tooltip Label : Tooltip info).</td>
</tr>
</tbody>
</table>

4. Click **Submit** to enter a new map indicator. Click **Update** to modify an existing map indicator.

For an indicator to appear in a Dependency Views map, a CI must meet all filter conditions, and **Active Dependencies** must be selected.

**Create or modify map icons**

You can upload new icons or modify existing icons to customize the icon displayed for a CI in maps in Dependency Views, Service Mapping, and Event Management.

The icons used in Dependency Views maps are listed in the Map Icons module. Records in the **Map Icons** list are arranged by CI classes, such as cmdb_ci_linux_server. The path to the default image files is https://<instance name>.service-now.com/images/app.ngbsm/<image name.svg>. For information about uploading images to the database, see **Storing images in the database**.

Role required: admin or cmdb_admin roles are required to access the records in this table [ngbsm_icon] to upload new icons.

- Navigate to **Configuration > CI Class Manager**, and:
  - a) Click **Hierarchy** to display the CI Classes list.
  - b) Select a class to modify the icon for.
  - c) In the class navigator bar, expand **Class Info** and then select **Basic Info**. On the Basic Info form, click **Icon**.
  - d) In the Icons dialog box, select an icon and then click **Update**.
  - e) On the **Basic Info** form, click **Update**.
• Navigate to **Dependency Views** > **Map Icons**, and:
  a) Click **New** to create a new map icon or click the name of an existing icon in the **Label** column to modify an existing icon.
  b) Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Type</td>
<td>Label or the informal name of the CI table that this icon represents in the view.</td>
</tr>
<tr>
<td>Icon</td>
<td>Name of the icon.</td>
</tr>
<tr>
<td>URL</td>
<td>Path to the icon image using the following format: /image name.svg. Click the lock icon to enter a new path.</td>
</tr>
</tbody>
</table>

c) Fill in the fields on the form, as appropriate.
d) Click **Submit** to enter a new icon. Click **Update** to modify an existing icon.

You can modify a Dependency Views map indicator to use the new icon.

**Create a predefined filter**

Create filters to narrow down the CIs that are displayed on a Dependency Views map. You can create filters that are based on CIs' class, CIs' attributes, or CIs' relationships.

Role required: ecmdb_admin

Create a predefined filter that you can then select to determine the scope of the CIs that are displayed in a Dependency Views map. **Configuration type** filters filter by CI class, **CI filters** filter by CI attributes, and **relationship filters** filter by relationships. Only CIs that match at least one of the configuration type filters (if any exists), and at least one of the CI filters (if any exists), and at least one of the relationship type filters (if any exists) - are displayed on the map. If no filters are defined, then no filtering is applied.

**Note:** Predefined filters do not apply to virtual groups. Therefore a virtual group displays even if it contains CIs that a predefined filter would have not included. Upon the expansion of a virtual group, predefined filters are applied, and any or all of the CIs that were previously virtually grouped, might no longer display on the map.

1. Navigate to **Dependency Views** > **Predefined Filters**.
2. On the **Predefined Filters** page, click **New**.
3. Type in a **Name** for the filter. Click **Roles**, and in the **Roles** dialog box, select the roles that this filter will be available for.
4. Right-click on the page header, and click **Save**.
5. To create a configuration type filter:
   a) Click **Configuration Types**, and then click **Edit**.
   b) In the **Collection** slushbucket, select the classes that CIs must belong to in order to be displayed on the map, and move them to the **Configuration Types List**.
   c) Click **Save**.
6. To create a CI filter:
   a) Click **CI Filters**, and then click **New**.
   b) In the **CI Filters** page enter conditions to filter CIs by specific attribute values.
   c) Click **Submit**.

7. To create a relationship type filter:
   a) Click **Relationship Type**, and then click **New**.
   b) In the **Collection** slushbucket, select the relationships that CIs must have in order to be displayed on the map, and move them to the **Relationship Types List**.
   c) Click **Save**.

After creating a predefined filter, you can apply it to a map:
1. Click the icon to open **Map Settings**.
2. Select a filter from the **Predefined Filters** list.
3. Click **Apply**.

### Set a predefined filter as default

You can set a custom predefined filter as the default predefined filter for viewing maps.

1. Create the custom predefined filter to be used as the default predefined filter.
2. On the predefined filter form, click the context menu and select **Copy sys_id**.
3. Navigate to **User Administration > User Preferences**.
4. Click **New** and create a new user preference record using these values:
   - **Name**: ecmbd.ciview
   - **Type**: String
   - **Value**: Paste the sys_id of the custom predefined filter
   - **User**: Leave blank to create a system-wide setting
   - **Description**: Description of the predefined filter
   - **System**: Selected
5. Click **Submit**.

In **Map Settings**, when you select the **Default** option for **Predefined Filters**, the custom predefined filter that was set, will be applied.

### Create or modify Map Related Items

The Map Related Items module relates referenced CIs to one another, which allows them to be displayed in a Dependency Views map.

The base system configuration includes the following tables and relates them to items in the Computer [cmdb_ci_computer] and Server [cmdb_ci_server] tables.

- Disk [cmdb_ci_disk]
Some additional referenced CIs that can be related in this manner are file systems and running processes.

In the following example, computer nodes in the map are related to network adapter nodes if the **Configuration Item** field of the adapter records reference the specific CI node. Access or create a network adapter record from the Network Adapter related list in the cmdb_ci_computer record.

Dependency Views Configuration Item field

The Dependency Views map for the *JEMPLOYEE-IBM* computer shows the network adapter attached to the computer.
You can configure Dependency Views to display CIs that have no relationship record, but are related to other CIs by reference fields.

1. Navigate to **Dependency Views > Map Related Items**.
2. Click **New** to create a new related item, or click in the row of an existing CI to modify an existing map related item.
3. Fill in the fields on the form, as appropriate.
   See the Related Items form table.
4. Click **Submit** to enter a new map related item. Click **Update** to modify an existing map related item.

### Related Items form

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration item</td>
<td>CI that represents the base node or a CI in a table that extends the base node table. In the base system, the configuration item that represents the base node is Computer [cmdb_ci_computer], which includes all types of workstations and servers.</td>
</tr>
<tr>
<td>Related item</td>
<td>Table name of the related item. Only the cmdb_ci table and tables that extend it are displayed in the choice list.</td>
</tr>
<tr>
<td>Related field</td>
<td>Field that links this related item to the configuration item. In many cases, the appropriate value is automatically populated in the field after the first two fields are selected. Select the drop-down menu for additional options.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that allows you to enable or disable this record.</td>
</tr>
</tbody>
</table>

**Create or modify Dependency Views menu actions**

To modify an existing menu option, first you create a copy of the original menu action record, and then you modify the copy.

This ensures that your instance can update the record normally during the upgrade process and allows you to quickly restore the original menu option, if necessary.

1. To create a new menu option, navigate to **Dependency Views > Map Menu Actions** and click **New**. Fill in the fields on the form, as appropriate. See the Menu Action form table.
2. To modify an existing menu option, navigate to **Dependency Views > Map Menu Actions**.
3. Open the menu action you want to edit.
4. Right-click in the header and click **Insert and Stay**. This step creates a duplicate copy of the menu action and leaves it open for editing.
5. Change the name of the copied record to avoid confusion.
6. Modify the form fields as necessary and save the record.
7. Open the original record and disable it by clearing the **Active** check box.

**Menu Action form**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name that appears as the menu option.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that allows you to enable or disable this record.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition that triggers the display of this menu option. If the condition</td>
</tr>
<tr>
<td></td>
<td>evaluates to false the menu option does not display. Script is evaluated</td>
</tr>
<tr>
<td></td>
<td>in JavaScript in the user's browser and does not have access to all the</td>
</tr>
<tr>
<td></td>
<td>APIs that Business Rules do. For details on available parameters, see</td>
</tr>
<tr>
<td></td>
<td>Condition Parameters.</td>
</tr>
<tr>
<td>Item</td>
<td>Map element for which the menu option displays. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Canvas</strong> for the menu on the map background.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Node</strong> for the menu on a CI.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Relationship</strong> for the menu on a relationship link.</td>
</tr>
<tr>
<td>Order</td>
<td>Physical location of the option in the menu. The option with the lowest</td>
</tr>
<tr>
<td></td>
<td>order number appears first in the menu. All editable and custom options</td>
</tr>
<tr>
<td></td>
<td>appear below the permanent menu options.</td>
</tr>
<tr>
<td>Script</td>
<td>Script that is executed in the browser when the menu option is selected.</td>
</tr>
<tr>
<td></td>
<td>Script is evaluated in JavaScript in the user's browser and does not have</td>
</tr>
<tr>
<td></td>
<td>access to all the APIs that Business Rules do.</td>
</tr>
<tr>
<td>Type</td>
<td>Menu action type being created, either a menu option or a menu separator.</td>
</tr>
<tr>
<td></td>
<td>The menu separator is a single line. When the type is a separator, the</td>
</tr>
<tr>
<td></td>
<td><strong>Script</strong> field is ignored.</td>
</tr>
</tbody>
</table>

**Condition and script parameters for menu actions**

You can use the following condition and script parameters for menu actions.

**Condition parameters**

**Note:** The usual regular expression conventions are valid in the condition field, such as `!` for NOT, `&&` for AND, and `||` for OR.

The **Condition** field contains a boolean expression that evaluates to true or false. If the condition is true or if there is no condition, the specified option appears in the menu when you right-click a CI or a relationship link. When you select the option from the menu, ServiceNow executes the associated script.
Common Elements for Building a Condition

<table>
<thead>
<tr>
<th>Text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>item</td>
<td>Node or reference link's data on which you performed the right-click action.</td>
</tr>
<tr>
<td>item.label</td>
<td>Label of the node</td>
</tr>
<tr>
<td>item.ci_type</td>
<td>CI's type (table), such as cmdb_ci_service</td>
</tr>
<tr>
<td>item.name</td>
<td>Name of CIs. CI's type name or the table label</td>
</tr>
<tr>
<td>item.location</td>
<td>Location of the CI, such as New York</td>
</tr>
<tr>
<td>item.manufacturer_name</td>
<td>Name of the CI's manufacturer, such as Dell Inc.</td>
</tr>
<tr>
<td>item.id</td>
<td>The sys_id of the CI</td>
</tr>
<tr>
<td>item.is_selected</td>
<td>The item that is selected in the map</td>
</tr>
<tr>
<td>item.level</td>
<td>The current default level</td>
</tr>
<tr>
<td>item.locationId</td>
<td>The sys_id of the CI node's location</td>
</tr>
<tr>
<td>item.locationName</td>
<td>The full address of the location</td>
</tr>
<tr>
<td>item.manufacturerId</td>
<td>The sys_id of the CI's manufacturer</td>
</tr>
</tbody>
</table>

Valid Conditions for Condition Parameters

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>item.is_collapsed</td>
<td>The node is a collapsed node</td>
</tr>
<tr>
<td>item.is_cluster</td>
<td>The node is a cluster node</td>
</tr>
</tbody>
</table>

Script parameters

Menu action scripts are executed on the client when a user clicks the menu option. You can use the same building blocks in scripts as in conditions. Menu action scripts do not function on separators. These are some additional, useful expressions for scripts:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>item.id</td>
<td>The sys_id of the CI node or relationship link</td>
</tr>
<tr>
<td>item.source</td>
<td>The sys_id of the relationship's parent or child.</td>
</tr>
<tr>
<td>item.target</td>
<td>The sys_id of the relationship's parent or child.</td>
</tr>
<tr>
<td>item.label</td>
<td>The name of the CI node, such as IronMail-SD-02.</td>
</tr>
<tr>
<td>item.location</td>
<td>The sys_id of the CI node's location</td>
</tr>
<tr>
<td>item.location_name</td>
<td>The full address of the location, such as 4616 Clairemont Drive, North Clairemont, San Diego CA.</td>
</tr>
<tr>
<td>item.manufacturer_id</td>
<td>The sys_id of the CI's manufacturer</td>
</tr>
</tbody>
</table>
Create or edit a dependency type

Use one of the dependency types provided, or create a custom dependency type with a script that will execute in real time to generate a custom view of a Dependency Views map for a specific CI.

Create a JavaScript to customize the map. The script must comply with JavaScript syntax guidelines and the directions in the default script template, and it can call platform APIs. Use a dependency type, for example:

- To narrow down and simplify a map, leaving out CIs that are not important for a specific task.
- To include only specific CIs that are hidden by default, such as qualifiers, end-points, and entry points.
- To display virtual relationships that are calculated, and that otherwise do not exist in the CMDB.
- As a tool to plan a new topology deployment that is based on existing resources.

The following dependency types are included in the base system:

**Application to Network Devices**

Returns the network devices in the network paths leading to/from the given CI.

**Network Device to Applications**

Returns the applicative CIs which are target or source of network paths containing the given network device. In addition, returns the hosts of those applicative CIs, and for an applicative CI that is an inclusion, its parent CI is returned too.

**Physical Network Connections**

Returns hosts/network devices that are physically connected to the given host or network device.

**Flow Dependencies**

Returns all the server to server connections that were discovered using the Netflow collector. The script builds a graph based on data in the [sa_flow_server_comm] table. This table contains pairs of services represented by an IP and a listening port that are communicating with each other. For more information, see Data collection and discovery using Netflow and Data collection and discovery using VPC Flow Logs.

**Show All Relationships**

Returns all qualifiers, end points, and entry points. This dependency type is disabled by default and is typically enabled for debugging and tracking purposes.

1. Navigate to Dependency Views > Dependency Types.
2. In the Load Filter Scripts list view, select an existing dependency type, or click New.
3. Enter or modify a script, adhering to the guidelines and requirements in the script template that is provided.
4. Click Submit.

In a Dependency Views map, you can click Use Dependency Type to apply a custom script defined in a dependency type.

**Properties for Dependency Views**

Use Dependency Views properties to configure how data appears in Dependency Views maps.

These properties are available for Dependency Views. To view and edit these properties, the admin role is required.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.bsm.max_nodes | The maximum number of nodes to retrieve from the database. If more nodes exist in the database, they are not displayed in the map.  
- Type: Integer  
- Default value: 1000  
- Location: **Dependency Views > Map Properties** |
| glide.bsm.max_levels | Level depth is the graph distance between the root CI and a node.  
- Type: Integer  
- Default value: 3  
- **Other possible values:** 1-49  
- Location: **Dependency Views > Map Properties** |
| glide.bsm.show_virtual_node_children | Display the continuation of the map underneath virtual group. Virtual links are used to connect virtual groups to their child nodes.  
- Type: Yes | No  
- Default value: No  
- Location: **Dependency Views > Map Properties** |
| glide.bsm.too_many_children | Maximum number of nodes (of a similar CI type and at the same level) to display before applying virtual grouping. Nodes are collapsed for the map to meet this limit.  
- Type: Integer, valid values 1 or greater  
- Default value: 10  
- Location: **Dependency Views > Map Properties** |
| glide.ngbsm.filters_remove_filtered_items | A value of true indicates that filtered out items will be removed from the graph along with any disconnected children while a value of false indicates that the items will be dimmed in color.  
- Type: Yes | No  
- Default value: Yes  
- Location: **Dependency Views > Map Properties** |
| glide.bsm.max_num_rels | The maximum number of relations to retrieve from the database. If more relations exist in the database, they are not displayed in the map.  
- Type: Integer  
- Default value: 100  
- Other values: 1 or greater  
- Location: **Dependency Views > Map Properties** |
| glide.ngbsm.filters_run_layout_automatically | A value of true indicates that when filters are changed the graph will recalculate it layout using the currently selected layout algorithm.  
- Type: Yes | No  
- Default value: Yes  
- Location: **Dependency Views > Map Properties** |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ngbsm.filters_fit_to_screen_automatically</td>
<td>A value of true indicates that when filters are changed the graph will be fit to the screen automatically.</td>
</tr>
<tr>
<td>glide.ngbsm.performance_allow_curves</td>
<td>A value of true allows relationship lines to be drawn using smooth curves instead of straight line segments. These curves can be more taxing on the browser, setting to false may improve fluidity of animation and interaction for Dependency Views.</td>
</tr>
<tr>
<td>glide.ngbsm.notification_display_time</td>
<td>Amount of time in milliseconds a notification stays on the screen.</td>
</tr>
<tr>
<td>glide.ngbsm.search_ci_limit</td>
<td>The maximum amount of results displayed when searching for CIs.</td>
</tr>
<tr>
<td>glide.ngbsm.search_rel_type_limit</td>
<td>The maximum amount of results displayed when searching for Relationship Types.</td>
</tr>
<tr>
<td>glide.ngbsm.show_class_labels</td>
<td>When available, the map should display the class labels for each CI.</td>
</tr>
<tr>
<td>glide.ngbsm.truncate_long_labels</td>
<td>Truncate node labels to a single line and to fit available space (default). Disable to display entire labels on multiple lines and wrapped as needed.</td>
</tr>
<tr>
<td>glide.bsm.layout_horizontal_spacing_x</td>
<td>Minimum horizontal distance between nodes in horizontal layout.</td>
</tr>
</tbody>
</table>

- **Type**: Yes | No
- **Default value**: No
- **Location**: Dependency Views > Map Properties
- **Type**: Yes | No
- **Default value**: Yes
- **Location**: Dependency Views > Map Properties
- **Type**: Integer
- **Default value**: 5000
- **Location**: Dependency Views > Map Properties
- **Type**: Integer
- **Default value**: 10
- **Location**: Dependency Views > Map Properties
- **Type**: Integer
- **Default value**: 5
- **Location**: Dependency Views > Map Properties
- **Type**: Yes | No
- **Default value**: Yes
- **Location**: Dependency Views > Map Properties
- **Type**: Yes | No
- **Default value**: No
- **Location**: Dependency Views > Map Properties
- **Type**: Integer
- **Default value**: 200
- **Location**: Dependency Views > Map Properties
### Components installed with Dependency Views

Several types of components are installed with the activation of the Next_Gen BSM (com.snc.ng_bsm) plugin, such as tables.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available CI icons</td>
<td>Stores all available CI class icons.</td>
</tr>
<tr>
<td>[ngbsm_ci_icons]</td>
<td></td>
</tr>
<tr>
<td>Icons for CI types</td>
<td>Maps icons to CI class names.</td>
</tr>
<tr>
<td>[ngbsm_ci_type_icon]</td>
<td></td>
</tr>
<tr>
<td>Map Script</td>
<td>Custom scripts that run in real time and generate a custom view of a map for a specific CI.</td>
</tr>
<tr>
<td>[ngbsm_script]</td>
<td></td>
</tr>
<tr>
<td>Map View</td>
<td>Serialized map views saved by users.</td>
</tr>
<tr>
<td>[ngbsm_view]</td>
<td></td>
</tr>
<tr>
<td>Map Filter</td>
<td>Filters saved by users.</td>
</tr>
<tr>
<td>[ngbsm_filter]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Menu Action</td>
<td>Default and custom context menu actions that appear when users right click a map.</td>
</tr>
<tr>
<td>[ngbsm_context_menu]</td>
<td></td>
</tr>
<tr>
<td>Related Item</td>
<td>Stores which reference fields should be treated as relationships when building the map. This allows users to include CI's that are related via a reference field instead of a relationship.</td>
</tr>
<tr>
<td>[ngbsm_related_item]</td>
<td></td>
</tr>
<tr>
<td>Edge Colors</td>
<td>Color definitions to use when drawing the relationships between nodes based on relationship type.</td>
</tr>
<tr>
<td>[bsm_edge_color]</td>
<td></td>
</tr>
<tr>
<td>Map Indicator</td>
<td>Stores all map indicators.</td>
</tr>
<tr>
<td>[bsm_indicator]</td>
<td></td>
</tr>
<tr>
<td>BSM Saved Map</td>
<td>Details of maps.</td>
</tr>
<tr>
<td>[bsm_graph]</td>
<td></td>
</tr>
<tr>
<td>BSM Map Actions</td>
<td>Actions on the map.</td>
</tr>
<tr>
<td>[bsm_action]</td>
<td></td>
</tr>
<tr>
<td>BSM Map View</td>
<td>Parents' predefined filters.</td>
</tr>
<tr>
<td>[map_view]</td>
<td></td>
</tr>
<tr>
<td>Map View Configuration Types</td>
<td>Configuration type filters, limiting the CI class types to be displayed, per predefined filter.</td>
</tr>
<tr>
<td>[map_view_ci_type]</td>
<td></td>
</tr>
<tr>
<td>Map View Relationship Types</td>
<td>Relationship type filters, limiting the links to be displayed between CIs, per each predefined filter.</td>
</tr>
<tr>
<td>[map_view_rel_type]</td>
<td></td>
</tr>
<tr>
<td>[map_viewroles]</td>
<td>Roles that a specific predefined filter should be applied to.</td>
</tr>
<tr>
<td>CI Filters</td>
<td>CI attribute filters, limiting the CIs to be displayed, per predefined filter.</td>
</tr>
<tr>
<td>[map_filter]</td>
<td></td>
</tr>
</tbody>
</table>

**Connect**

ServiceNow® Connect is a real-time messaging platform that connects you to your coworkers, bypassing email and static documents.

Connect integrates with other features within the system, such as Visual Task Boards, Human Resources Management, and Customer Service Management. The Connect interface overlays the standard interface, which allows users to participate in conversations while they work.

Connect contains the following features:

- **Connect Chat**: Enables users to chat with individuals and groups, quickly share files, and collaborate on any record by connecting with the right people instantly.
- **Connect Support**: Enables support agents to provide real-time assistance to end users, using queues. Requires the Connect Support plugin.
UI16 or UI15 is required to use Connect.

**Note:**
- Connect does not replace legacy chat but offers some of the same functionality. Do not use these features concurrently.

**Explore**
- Upgrade to New York
- Connect interface
- Connect Chat
- Connect Support

**Set up**
- Activate Connect
- Activate Connect Support
- Supported browsers for Connect

**Administer**
- Properties for Connect
- Connect actions
- Configure the fields on a record card in Connect
- Properties for Connect Support

**Use**
- Start a direct or group conversation
- Follow a record in Connect
- Create an incident from a Connect Support conversation

**Develop**
- Developer training
- Developer documentation

**Troubleshoot and get help**
- Ask or answer questions in the Connect forum
- Search the HI Knowledge Base for known error articles

**Supported browsers for Connect**

The system supports Connect Chat and Connect Support on most modern browsers.

- The latest public release of Firefox or Firefox ESR
- The latest public release of Chrome
- Safari version 9.1 and later
- Internet Explorer version 11
  - Edge mode is supported.
  - Compatibility mode is not supported.
  - Setting Security Mode to High (via the Internet Options > Security tab) is not supported.
  - Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7.

**Activate Connect**

Connect is active by default on new instances. For upgraded instances, you can activate the Connect plugin (com.glide.connect) if you have the admin role.

Role required: admin

If you used Collaboration in the Fuji release, the Connect plugin is activated automatically.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Properties installed with Connect

Properties are added with activation of Connect.

**Note:** To open the System Property [sys_properties] table, enter **sys_properties.list** in the navigation filter.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>collaboration.email_interval</td>
<td>Sets the number of minutes the system waits before sending a Connect notification email to an inactive user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 3</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> Collaborate &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>• <strong>Learn more:</strong> Configure the email notification interval</td>
</tr>
<tr>
<td>collaboration.frameset</td>
<td>Determines whether the Connect overlay is visible (enabled). This property also impacts Connect Support.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> Collaborate &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>• <strong>Learn more:</strong> Disable the Connect overlay</td>
</tr>
<tr>
<td>collaboration.polling_interval</td>
<td>Sets the number of seconds the system waits between polling for new Connect messages. This property also impacts Connect Support.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 10</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> System Property [sys_properties] table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>connect.notification.audio_alert</td>
<td>Specifies the audio file to play to notify users of new messages, support conversation transfers, and @mentions in Connect. This property's value must point to the Name field of a record in the Audio File [db_audio] table. This property also impacts Connect Support.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: string</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: connect_alert.mp3</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>• <strong>Learn more</strong>: Customize the Connect audio notification sound</td>
</tr>
<tr>
<td>connect.retrieve_external_link_content</td>
<td>Enables Connect to render URLs for external sites as links. When this property is disabled, URLs that point anywhere outside the instance appear as plain text. This property also impacts Connect Support.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>connect.roles</td>
<td>Determines which user roles are required to access Connect. When the value is blank, no role is required. This property also impacts Connect Support.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: string</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: &lt;empty&gt;</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>glide.connect.enabled</td>
<td>Hides the <strong>Create or Join Chat Room</strong> related link, which appears on the Incident form when legacy chat is enabled. Legacy chat and Connect Chat should not be used concurrently and this property should not be modified.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Administration &gt; Properties</td>
</tr>
</tbody>
</table>
### Activate Connect Support

You can activate the Connect Support plugin (com.glide.connect.support) if you have the admin role. This plugin includes demo data.

If you are currently using the legacy chat feature to provide help desk support, close any open help desk chats before activating Connect Support. Legacy chat and Connect Support should not be used concurrently. When you activate Connect Support, the system automatically sets the state of all Chat Queue Entry [chat_queue_entry] records to **Closed Complete**. This ends any open help desk chats. For more information, see [Migrate from legacy chat to Connect Support](#).

**Role required:** admin

1. Navigate to **System Applications** > **All Available Applications** > **All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
### Properties installed with Connect Support

Properties are added with activation of Connect Support.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connect.support.conversation_limit</td>
<td>Determines how many support conversations an individual agent can have at one time. When the value is set to -1, an agent can participate in an unlimited number of conversations.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: -1</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Support Administration &gt; Properties</td>
</tr>
<tr>
<td>connect.support.idle.delay</td>
<td>Determines how many seconds a user must be inactive in a support conversation before an idle countdown timer appears.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 120</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Support Administration &gt; Properties</td>
</tr>
<tr>
<td>connect.support.idle.count_down</td>
<td>Determines how many seconds the idle countdown timer remains open after it appears. If the idle user does not dismiss the timer before the countdown completes, the system closes the support session.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 60</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Support Administration &gt; Properties</td>
</tr>
<tr>
<td>connect.support.show_agent_avatar</td>
<td>Determines whether an agent's avatar is shown in a support conversation (enabled). When the property is disabled, users see the agent's name only.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Support Administration &gt; Properties</td>
</tr>
<tr>
<td>connect.support.user.closed.conversation_limit</td>
<td>Determines how many closed conversations appear in a user’s support conversation history. When the value is set to 0, all previous conversations appear in the history.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 0</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Support Administration &gt; Properties</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.connect.support.enabled</td>
<td>Disables or enables Connect Support. When the property is enabled, the Service Desk Chat button in the Employee Self-Service portal opens the conversation in Connect Support, rather than legacy chat. Additionally, the Support tab appears in the Connect sidebar.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Collaborate &gt; Support Administration &gt; Properties</td>
</tr>
<tr>
<td>glide.connect.support.reflect_system_messages</td>
<td>Controls whether Connect Support reflects system messages in records created from a support chat, for example, transfer notices, automated queue messages, etc.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: false</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property [sys_properties] table</td>
</tr>
</tbody>
</table>

### Additional plugins for Connect Support

Additional plugins are available for Connect Support. These plugins integrate Connect Support with other features and provide capabilities to track performance metrics.

You must have the admin role to activate these additional plugins. For details, see [Activate a plugin](#).

#### Additional plugins for Connect Support

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect Support Manager’s Dashboard [com.glide.connect.managers_dashboard]</td>
<td>Provides a homepage for Connect Support, and all required configuration records. Though the plugin name contains the term dashboard, the plugin does not provide functionality related to Performance Analytics dashboards. Homepages are similar to dashboards, but do not require Performance Analytics roles to view.</td>
</tr>
</tbody>
</table>

**Note:** The Connect Support Manager’s Dashboard plugin does not activate Connect Support automatically. You must activate Connect Support to collect data for the homepage.
### Human Resources Application: HR Connect

**[com.snc.hr.hr_connect]**

Sets up a human resources (HR) chat queue and makes it available on the HR Service Portal.

**Note:** This plugin does not appear in the System Definition>Plugins list. Contact ServiceNow personnel to activate it.

If not already active, the Human Resources Application: HR Connect plugin activates these related plugins:

- **Human Resources Application: Core**
  
  **[com.snc.hr.core]**: Provides basic HR features.

### Performance Analytics - Content Pack - Service Desk Chat

**[com.snc.pa.chat]**

Provides the **Service Desk Chat Monitor** dashboard, which analyzes key Connect Support metrics and indicators.

The Performance Analytics - Content Pack - Service Desk Chat plugin activates these related plugins if they are not already active:

- **Connect Support Manager's Dashboard**
  
  **[com.glide.connect.managers_dashboard]**: See description in this table.

### Performance Analytics - Context Sensitive Analytics for Chat

**[com.snc.pa.chat.context_sensitive_analytics]**

Provides in-form analytics for Connect Support. These analytics are available as a related link on the Chat Queue Entry [chat_queue_entry] form, and also as the **Context Sensitive Analytics - Chat** dashboard.

The Performance Analytics - Context Sensitive Analytics for Chat plugin activates these related plugins if they are not already active:

- **Performance Analytics - Content Pack - Service Desk Chat**
  
  **[com.snc.pa.chat]**: See description in this table.

### Connect interface

Users can work in a compact view of Connect, which overlays the standard user interface, or in a full-screen workspace.

Connect Chat and Connect Support share the same interface, so support agents can keep track of all their conversations in one place.

### Connect overlay

The Connect overlay appears over the standard user interface. It consists of the Connect sidebar, which is the primary interface for Connect Chat and Connect Support, and any Connect mini windows that are open. Each mini window contains a header, a conversation area, and a message field.
**Note:** An administrator can disable the Connect overlay so users can only use the Connect workspace, a full-screen interface with additional Connect tools.

**Connect sidebar**

The Connect sidebar is the primary interface for Connect Chat and Connect Support. It lists your conversations and provides access to create conversations.

The sidebar is collapsed by default. Click the toggle Connect sidebar icon (in the banner frame to expand or collapse the sidebar, which appears on the right edge of the interface.

**Connect Chat**

The chat view of the sidebar is available to all users. If Connect Support is enabled, users must click the chat tab of the sidebar, which is represented by a speech bubble icon. If Connect Support is not enabled, there are no tabs in the sidebar and the chat view displays by default.

The chat view of the sidebar lists all your current Connect Chat conversations. It also contains a filter tool and a button to create conversations.
Chat view of the Connect sidebar

If you have unread messages in a conversation, a number appears by the conversation in the sidebar. Point to a conversation and click the x icon to remove the conversation from the sidebar.

**Connect Support**

The support view of the sidebar is available when Connect Support is activated. The support view is visible only to users who are agents for at least one support queue. Users must click the support tab of the sidebar, which is represented by a headset icon.

The support view displays **Queues** to which you belong. It also displays your open support conversations under **Cases**.
If you have unread messages in a conversation, a number appears by the conversation in the sidebar.

Support view of the Connect sidebar

Connect mini windows

When you open a Connect Chat or Connect Support conversation in the Connect overlay, it opens in a Connect mini window. Each mini window contains a header, a conversation area, and a message field.

Several icons appear in the mini window header and by the message field.

Note: The icons you see for each conversation depend on the conversation type and other conditions.

Chat mini window icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>👤</td>
<td>Add user</td>
<td>Add a user to the conversation. This icon is visible for group and record conversations only. Administrators can enable this icon for Connect Support conversations.</td>
</tr>
<tr>
<td>Icon</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>View document</td>
<td>View the record associated with the conversation. This icon is visible for record and support conversations only.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>New window</td>
<td>Open the conversation in the Connect workspace, a full-screen window with additional Connect tools.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Collapse/Expand conversation</td>
<td>Hide or show the conversation. Alternatively, click anywhere in the mini window header to the left of the icons.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Close window</td>
<td>Close the mini window. The conversation remains in the Connect sidebar and the history is preserved when you reopen the conversation. You can also close a mini window by pressing the Escape key.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Connect actions</td>
<td>Open the Connect actions menu, which contains options like Transfer and Create Incident. This icon is visible only when Connect actions are available for the conversation. By default, this icon is visible for support conversations only. Administrators can add options to this menu by creating Connect actions.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Message type</td>
<td>Choose whether messages are added to the associated record as comments or work notes. This icon is visible only for record and support conversations.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Attach file</td>
<td>Attach and send a file. Select one or more files and click Open. You can also add an attachment by dragging and dropping it directly in the conversation.</td>
</tr>
</tbody>
</table>

**Connect workspace**

The Connect workspace is a full-screen view of all your Connect Chat and Connect Support conversations in one place. It contains the conversation pane, which displays the conversation header and an expanded version of the mini window, and the conversation tools area.

To open the Connect workspace, navigate to **Collaborate > Connect Chat** or click the new window icon in a Connect mini window. If you do not have any recent conversations, a screen appears with helpful information about Connect.

The Connect workspace is composed of the following elements.
## Connect workspace elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sidebar</td>
<td>Provides access to conversations. The Connect sidebar behaves the same way in the workspace as it does in the Connect overlay. The only difference is that the sidebar appears on the left edge of the Connect workspace. For more information about using the sidebar, see <a href="#">Connect sidebar</a>.</td>
</tr>
<tr>
<td>Conversation pane</td>
<td>Displays the currently selected conversation.</td>
</tr>
<tr>
<td>Conversation tools</td>
<td>Provides quick access to key information, conversation members, attachments, and notification preferences for the currently selected conversation. Some of the conversation tools vary depending on the type of conversation.</td>
</tr>
</tbody>
</table>
Connect workspace
Conversation pane

The conversation pane of the Connect workspace displays the conversation header and an expanded version of the mini window.

The header displays basic conversation details like the avatar and name. You can edit these details for group or record conversations.

Below the header, messages appear in chronological order. You can enter messages in the text entry field at the bottom of the window.

Connect conversation tools

The conversation tools area in the Connect workspace contains several tabs, each represented by an icon. Click an icon to open the tab. Click the same icon again to hide the tab. The tabs you see for each conversation depend on the conversation type and other conditions.

### Conversation tool tabs

<table>
<thead>
<tr>
<th>Tab icon</th>
<th>Tab name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📝</td>
<td>Info</td>
<td>Contains the following sections, each of which appears only if it contains information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Record</strong>: Lists details about the record the current conversation follows, such as record number, state, assignee, and short description. The fields displayed in this section vary by the type of record. This section is available only for record conversations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Related Records</strong>: Lists Visual Task Boards and task records that have been referenced in the conversation, such as incidents, problems, or changes. When you send a record number as a message or drag a record in a conversation, it appears as a link. The list displays the short description for each task. Click a task to open the record in a new browser tab. Only conversation members who have rights to view the tasks can access them.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Links</strong>: Lists URLs that have been referenced in the conversation. Click a link to open the destination page in a new browser tab. This tab is not available for support conversations.</td>
</tr>
<tr>
<td></td>
<td>Record</td>
<td>Displays a compact form view of a record created from the current conversation, such as an incident. If more than one record has been created from the conversation, there is a separate record tab for each one. These tabs are available only for support conversations.</td>
</tr>
<tr>
<td></td>
<td>Knowledge</td>
<td>Displays a compact view of the knowledge homepage. For more information, see Share knowledge in a Connect Support conversation.</td>
</tr>
<tr>
<td></td>
<td>Base</td>
<td>Members</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Attachments</td>
</tr>
<tr>
<td></td>
<td>Notification</td>
<td>Contains settings to control which notifications you receive for the current conversation. For more information, see Edit which notifications you receive for a conversation.</td>
</tr>
</tbody>
</table>
Enable or disable Connect notifications globally

You can edit your Connect notification settings globally to enable or disable mobile, desktop, email, or audio notifications for all your Connect Chat and Connect Support conversations.

Role required: none

By default, Connect mobile, email, and audio notifications are enabled globally. You must enable desktop notifications.

An administrator can customize the sound used for audio notifications.

ℹ️ **Note:** You receive mobile notifications only if you have installed the ServiceNow mobile app.

1. In the banner frame, click the gear icon (⚙️) to open the system settings.
2. In the system settings window, click the **Notifications** tab.
3. In Notifications by Category, navigate to **Connect**.
4. Enable or disable Connect mobile, desktop, email, or audio notifications.
5. Optional: Configure the following system notifications. For more information on how to configure system notifications, see [Apply notification conditions](#).

<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Stream @Mention Email</td>
<td>Sends an email alert to a user anytime they get @mentioned in an activity stream</td>
</tr>
</tbody>
</table>
| Collaboration Offline Group Message(s)| Sends email to offline users who are members of a group conversation after a certain number of minutes determined by the collaboration.email_interval property to limit spam.  
   **Note:** It takes 90 seconds after a user logs out for the system to register that the user is offline. If a message is sent to the user within 90 seconds of them logging out, then the user does not receive the notification. |
| Collaboration Offline Message Bundle | Sends email to offline users after a certain number of minutes determined by the collaboration.email_interval property to limit spam.  
   **Note:** It takes 90 seconds after a user logs out for the system to register that the user is offline. If a message is sent to the user within 90 seconds of them logging out, then the user does not receive the notification. |
| ConnectMessagePushNotification       | Uses a push notification to inform users when there are new messages in a conversation |
| ConnectNotificationPushNotification  | Uses a push notification to inform a user when they have been @Mentioned in a record |
Edit which notifications you receive for a specific conversation.

**Connect notification browser support**

The following browsers support Connect chat notifications.

**Connect chat browser support**

<table>
<thead>
<tr>
<th>Browser</th>
<th>Enable notification steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chrome</td>
<td>1. From a Chrome window, click the Chrome menu in the upper right corner.</td>
</tr>
<tr>
<td></td>
<td>2. Go to Settings &gt; Show advanced settings... &gt; Privacy &gt; Content settings.</td>
</tr>
<tr>
<td></td>
<td>3. In the Content settings window, from the notifications section, select your notification settings.</td>
</tr>
<tr>
<td>Mozilla Firefox (starting with version 44)</td>
<td>Manage browser notification settings using the information icon next to the URL.</td>
</tr>
<tr>
<td>Safari (starting with OS X Mavericks)</td>
<td>1. From a Safari window, open Preferences.</td>
</tr>
<tr>
<td></td>
<td>2. Select the notifications tab.</td>
</tr>
<tr>
<td></td>
<td>3. Select Allow or Deny to control which websites have access to notifications.</td>
</tr>
<tr>
<td>Microsoft Edge</td>
<td>Notifications are enabled by default on Windows 10 PCs and tablets starting with EdgeHTML 14. For more information, see <a href="https://blogs.windows.com/msedgedev/2016/05/16/web-notifications-microsoft-edge/#pVkwubg7uvROayyL97">https://blogs.windows.com/msedgedev/2016/05/16/web-notifications-microsoft-edge/#pVkwubg7uvROayyL97</a>.</td>
</tr>
</tbody>
</table>

**Note:** Internet Explorer does not support Connect notifications out of box.

**Edit which notifications you receive for a conversation**

You can control which types of Connect notifications you receive for each conversation and when you receive them.

Role required: none

Connect can send mobile, desktop, email, and audio notifications to inform you of messages and other activity, when you are not actively viewing Connect. You can edit your notification preferences in each conversation to control which notifications you receive for the conversation and under what circumstances. For example, if you are a member of a large group conversation, you might want to receive mobile, desktop, and email notifications for all activity, and audio notifications only when someone mentions you. You might also want to disable a certain type of notification entirely for a conversation.

By default, you receive mobile, email, and audio notifications for all activity in every conversation you belong to. You must enable desktop notifications manually. Not all browsers allow desktop notifications. For more information, see [Enable or disable Connect notifications globally](#).
An administrator can **customize the sound** used for audio notifications.

**Note:** You receive mobile notifications only if you have installed the ServiceNow mobile app.

1. Open a conversation in the Connect workspace.
2. In the conversation tools to the right of the conversation, click the notification settings tab ( 🔔 ).
3. Edit the following settings according to your preferences.

**Note:** If a notification type is **disabled globally**, a link to enable that type appears. You must click the link before you can edit conversation-specific notification settings.

### Mobile Notification Settings
Choose to receive push notifications:
- For all activity
- Only when @ mentioned (this option is not available for direct conversations)
- Never

### Desktop Notification Settings
Choose to receive desktop notifications:
- For all activity
- Only when @ mentioned (this option is not available for direct conversations)
- Never

### Email Settings
Choose to receive email notifications:
- For all activity
- Only when @ mentioned (this option is not available for direct conversations)
- Never

### Audio Notification Settings
Choose to receive audio notifications:
- For all activity
- Only when @ mentioned (this option is not available for direct conversations)
- Never

### System Message Notifications
Enable or disable system message notifications, which are automatically generated by events like conversation membership changes and Visual Tasks.
Upload a profile picture

You can upload a profile picture in your Live Feed profile to use as an avatar in Connect Chat and Connect Support conversations.

Role required: none

Users who do not have profile pictures are represented by an avatar with their initials. Administrators can upload a profile picture in a user record which displays if there is no Live Feed photo.

1. Navigate to Collaborate > Live Feed.
2. Click the tile with your picture or initials and title.

3. Use one of the following actions to add your photo.
   - Locate the photo file you want to use and drag it over the existing photo.
   - Point to the existing picture (or tap the photo in the smartphone or tablet interface) to display the Upload a picture link. Click the link, navigate to the location of the photo you want to use, and click Open.
Drag a file into a Connect conversation

Drag and drop functionality in Connect Chat and Connect Support provides an easy way to share external attachments and links or items from within your instance.

Role required: none

You can drag several things from within an instance, including items from the application navigator, records or breadcrumbs from lists, and Visual Task Boards from the My Task Boards page.

Drag an item in a Connect mini window.

To drag a record from a list, drag the reference icon 

the record number, or a reference column value.

Connect accepts the same file extensions as the platform. For more information, see #unique_419.

Share a Visual Task Board in a Connect conversation

You can share a Visual Task Board in a Connect Chat or Connect Support conversation.

Role required: none

2. Drag a task board to a Connect mini window.

A link to the task board appears in the conversation. The task board is also listed in the conversation tools, which are visible in the Connect workspace. Only conversation members who are members of the board can access it. If you share a task board in a record conversation, it appears as a URL in the record activity stream.

Mention a user in a Connect conversation

You can get someone’s attention in a group conversation by mentioning them.

Role required: none

Users can set their notification preferences so they receive notifications only when they are mentioned. Mentioning a user creates a shortcut to view their basic information and send them a direct message.
1. Open a Connect group conversation.
2. In the message field, type the @ character.
   A suggestion menu appears with the names of the conversation members.
3. Select the person you want to mention and send the message.

**Connect administration**

Administrators can configure various performance settings and features that impact both Connect Chat and Connect Support.

**Note:** There are also administrative options specifically for Connect Chat or Connect Support. For more information, see Connect Chat administration and Connect Support administration.

**Domain separation in Connect Support and Connect Chat**

This an overview of how domain separation works in Connect Support and Connect Chat, and the expected interactions across domains to support multiple tenants. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.
Overview

Support: Level 1

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

Connect Support adheres to the standard domain separation patterns within ServiceNow, with some exceptions. Most notably, Connect Support allows for users in a parent or top-level domain to interact with chat_queue_entry records generated from child domains. Users can then pose questions in specifically-labeled chat_queues directly to the primary administrators of the instance.

Connect Chat supports data separation within domain separated instances. Delegated administration—the ability to override configuration settings and logic in domains—is not supported.

How domain separation works in Connect Support

Connect Support supports data separation within domain-separated instances. Delegated administration—the ability to override configuration settings and logic in domains—is not supported.

Configuration

Connect Support is configurable by system administrators only. Configuration settings apply to all domains. Overrides for configuration details and process logic in domains are not supported.

After domain separation has been enabled, the following Connect Support-related tables are not domain-separated in the base system:

- chat_queue
- connect_action

Records created from users in a child domain remain in the child domain to both the agent and the user initiating the chat. Any of the following tables represent records that support the conversation.

Records from conversations

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>chat_queue_entry</td>
<td>Holds the initial question from the end user, and other metrics to determine overall support efficiency, such as wait_time.</td>
</tr>
<tr>
<td>live_group_profile</td>
<td>Represents the conversation itself</td>
</tr>
<tr>
<td>live_group_member</td>
<td>Each individual member of the support conversation</td>
</tr>
<tr>
<td>Incident and other task-based records</td>
<td>Any record generated from connect_actions.</td>
</tr>
</tbody>
</table>

How domain separation works in Connect Chat

Configuration: Connect Chat is configurable by system administrators only. Configuration settings apply to all domains. Overrides for configuration details and process logic in domains are not supported.
Actions may be made available to specific domains based on condition filters set by system administrators.

Data Management: Connect Chat messages are not assigned to a domain. Rather, visibility is restricted to conversation participants.

**Usage scenarios**

Chat with users in the same domain (Supported)
- Domain visibility allows users to see other users in the same domain.
- Examples:
  - Service Provider user may chat with another Service Provider user
  - ACME user may chat with another ACME user

Parent domain user initiates chat with child domain user (Supported)
- Domain visibility allows users to see users in child domains.
- Examples:
  - Service Provider user may initiate a chat with a Service Provider sub-contractor user
  - ACME user may initiate a chat with ACME EMEA user

Domain user initiates chat with user in a domain where visibility has been granted (Supported)
- Domain visibility allows the user initiating a chat to see users in the target domain.
- Examples:
  - Service Provider sub-contractor user may initiate a chat with an Initech user, given domain visibility
  - Service Provider users may initiate a chat with any domain user, given the contains relationship with the TOP domain
Sub-domain user initiates chat with Parent domain user (Not supported)

- Domain visibility does not allow users in child domains to see users in parent domains. This means they are unable to initiate a chat session.

**Configuration**

Administrators may configure multiple Chat Queues. Support Queues are not assigned to a domain. Assignment groups may exist in any domain.

Any user with the appropriate link can enter a queue, regardless of the user’s domain. Exposure of links to specific queues through the default user interface may be controlled using domain-specific overrides. Exposure of links to specific queues through the Service Portal may be controlled using conditions or custom coding logic.

The Reporting Dashboard contains statistics related to all queues and all agents. Statistics are not filtered according to domain. Therefore, it is not appropriate to expose this page to users within child domains.

**Data management**

Connect Support Queues are global. No domain field exists on this table and it is not suitable for domain separation.

Connect Support messages are assigned to a domain based on the domain of the user entering the queue. Members of the Assignment group for the queue must have domain visibility to the user entering the queue to participate in chat sessions.

Records generated from chat sessions display based on the agent’s home domain. However, once the record is saved with a Company value, business rules assign the newly created record to the corresponding domain.

**Usage scenarios**

In the illustration above:

- The ACME support queue is configured to be available from 8-5 on weekdays. The ACME Support group in the ACME domain provides first-level support. If more advanced support is required, users are escalated to the Service Provider’s Service Desk queue.
• The Service Desk queue is configured to be available 24x7 and is staffed by the Service Desk Group in the Service Provider domain. If more advanced support is required, users are escalated to the Tier 2 Support queue in the same domain.

Properties for Connect

The Connect Properties page provides several configuration options for Connect.

Users with the admin role can access these properties by navigating to Connect > Administration > Properties.

Note: Many of the properties also impact Connect Support.

Properties for Connect

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Presence</td>
<td>Turns off user presence globally when enabled. Enabling this property turns off user presence throughout the platform, not just in Connect.</td>
</tr>
<tr>
<td>glide.ui.presence.disabled</td>
<td></td>
</tr>
<tr>
<td>Enable Connect in the frameset</td>
<td>Determines whether the Connect overlay is visible (enabled). This property also impacts Connect Support.</td>
</tr>
<tr>
<td>collaboration.frameset</td>
<td></td>
</tr>
<tr>
<td>Enable Connect to retrieve external link metadata in order to render richer content in messages with links to YouTube, news articles, images, etc.</td>
<td>Enables Connect to render URLs for external sites as links. When this property is disabled, URLs that point anywhere outside the instance appear as plain text. This property also impacts Connect Support.</td>
</tr>
<tr>
<td>connect.retrieve_external_link_content</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Number of minutes to wait before collecting unread messages and sending an email to offline users. collaboration.email_interval | Sets the number of minutes the system waits before sending a Connect notification email to an inactive user.  
- **Type**: integer  
- **Default value**: 3  
- **Location**: Collaborate > Administration > Properties  
- **Learn more**: Configure the email notification interval |
| Maximum number of latest conversations to show during search. (Default = 50) | Sets the number of results that appear when you search conversations in Connect. In the System Properties [sys_properties] table, this property appears as connect.search.conversation_limit.  
- **Type**: integer  
- **Default value**: 50 |
| Audio file to play to notify users of new messages, support conversation transfers and @mentions in Connect. connect.notification.audio_alert | Specifies the audio file to play to notify users of new messages, support conversation transfers, and @mentions in Connect. This property's value must point to the Name field of a record in the Audio File [db_audio] table. This property also impacts Connect Support.  
- **Type**: string  
- **Default value**: connect_alert.mp3  
- **Location**: Collaborate > Administration > Properties  
- **Learn more**: Customize the Connect audio notification sound |
| Comma separated whitelist of roles able to access Connect. Empty allows all roles. connect.roles | Determines which user roles are required to access Connect. When the value is blank, no role is required. This property also impacts Connect Support.  
- **Type**: string  
- **Default value**: <empty>  
- **Location**: Collaborate > Administration > Properties |

**Note**: If you choose to restrict Connect access to specific roles, consider updating the role requirements for Connect modules and other access points.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine whether or not a button is shown in task forms to view the Collaboration document conversation or Live Feed Record Feed related to the task. Note: The Collaboration button will only be enabled if the frameset view is also enabled with collaboration.frameset = true&lt;br&gt;glide.live_feed.task_header_button</td>
<td>Determines whether the show live feed icon ( ) and Follow button are available in the form header of tables that have the live_feed=true dictionary attribute.</td>
</tr>
<tr>
<td>Disable the legacy chat “Create or Join Chat Room” link on the Incident form (Must have Chat plugin enabled to see link)&lt;br&gt;glide.connect.enabled</td>
<td>Hides the Create or Join Chat Room related link, which appears on the Incident form when legacy chat is enabled. Legacy chat and Connect Chat should not be used concurrently and this property should not be modified.</td>
</tr>
</tbody>
</table>

**Configure the polling interval**

The polling interval determines how frequently the system polls for new Connect messages.

Role required: admin

The default interval is 10 seconds. You can change this value. The shorter the polling interval, the more frequently the system checks for new messages and the greater the impact on performance.

**Note:** This setting impacts Connect Chat and Connect Support.

1. Navigate to sys_properties.list.
2. Locate the collaboration.polling_interval property.
3. Set the Value to a different number of seconds.

Setting the polling interval to a value smaller than 2 is likely to tax the system too heavily, while a value greater than 10 is likely to result in a poor user experience.

**Disable the Connect overlay**

The Connect overlay is enabled by default and is integrated with the standard user interface. You can disable the Connect overlay.
Role required: admin

To disable the Connect overlay and remove the toggle Connect sidebar icon from the banner frame, set the `collaboration.frameset` property to `false`.

1. Navigate to Connect > Administration > Properties.
2. Locate the property called Enable Connect in the frameset (`collaboration.frameset`) and clear the check box.
3. Click Save.

When the frameset is disabled, any Connect chats open in the Connect workspace. For more information on completely disabling Connect Chat, see Disable Connect Chat.

**Customize the Connect audio notification sound**

You can replace the default Connect audio notification sound with an audio file of your choice.

Upload the audio file you want to use as the notification sound.

Role required: admin

The audio notification sound is used for all Connect conversation types, including Connect Support conversations.

1. Navigate to System UI > Audio Files.
2. Locate the audio file you want to use as the notification sound and copy the Name value.
3. Navigate to Connect > Administration > Properties.
4. Locate the property called Audio file to play to notify users of new messages, support conversation transfers and @mentions in Connect (`connect.notification.audio_alert`) and replace the default value with the name of the audio file.
5. Click Save.

End users receive audio notifications when sending and receiving support chats. Support agents only receive audio notifications for inbound chats when the chat window is not in focus.

**Administer Connect actions**

You can create or modify Connect actions to provide custom functionality in Connect Chat or Connect Support conversations.

If you want to customize the icon for a Connect action, navigate to Collaborate > Administration > Action Icons to view the available icons and their class names. Note the class name of the icon you want to use.

Role required: admin

The Connect action menu appears by the message entry field when one or more Connect actions are available for a conversation, based on defined conditions. When a user selects a Connect action, the system runs the script defined for that action.

1. Navigate to Connect > Administration > Actions.
2. Click New or open an existing record to edit a table.
3. On the form, fill in the fields.

### Connect Action form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>JavaScript condition statement that must return true for the action to be available in a conversation. For example, to show the action in Connect Support conversations only, enter `conversation.type === &quot;support&quot;</td>
</tr>
<tr>
<td>Hint</td>
<td>This field is not used.</td>
</tr>
<tr>
<td>Icon Class Name</td>
<td>Class name of the icon to use.</td>
</tr>
<tr>
<td></td>
<td>To view all available icons and their class names, navigate to Collaborate &gt; Administration &gt; Action Icons.</td>
</tr>
<tr>
<td>Order</td>
<td>Order of the action relative to other items in the Connect action menu.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to execute when the action is run. For example, to create a new incident that is based on the conversation, enter the following code:</td>
</tr>
</tbody>
</table>
|               | `response.newRecord("incident", 
|               |   { short_description: conversation.document.short_description || 
|               |     "", caller_id: conversation.document.opened_by });` |
|               | For information about the `response` object, see the ConnectActionResponse API reference documentation. |
|               | **Note:** You can only create a Connect action that is based on a task table. |
| Shortcut      | Text that triggers the action when entered after the "/" character in a conversation. |
| Title         | Text that appears in the Connect action menu. The title for each Connect action should be unique. |
Connect Actions form

Configure the fields on a record card in Connect

When a record is either linked to or create from a Connect conversation, the details of the record display as a card in the chat window.

The card view only applies to the full Connect page and the end user view of Connect Support conversations.

Role required: admin

1. Navigate to the form you want to configure fields for.
2. Right-click the header and select Configure > Form Layout.
3. Under the Form View section, select the Connect view. You may need to create a Connect view for the form. For more information on creating a form view, see Create and delete views.

4. Select the fields to appear on the card by adding or removing the fields from the Selected column. You can also adjust the order they appear on the form by moving the fields up or down. You cannot remove the Author or the Updated fields from the card regardless of whether they are on the view or not. The card always shows the Short Description field in the top even if it is in a different order in the list.

**Disable specific URLs for Connect**

Prevent users from accessing certain websites by disabling linking to specific Top-Level Domains (TLDs).

Role required: admin

1. In the navigation filter, type sys_properties.list.

2. Search for the glide.ui.url.external.top_level.domains system property.

3. In the value field, remove any TLDs that you do not want your users to have access to. For example, remove any TLDs that are commonly used for restricted websites, such as xxx or adult.

   The list of TLDs is based on the top 200 most common domains.

Any TLD not included in the value field becomes unclickable in Connect.

**Connect Chat**

Connect Chat is a real-time messaging tool that enables users to chat with individuals and groups, quickly share files, and collaborate on any record by connecting with the right people instantly.

Connect Chat animates communication around records, Visual Task Boards, topics of interest, or groups of people.

Features include:

- Direct conversations between two users.
- Group conversations between three or more users.
- Conversations linked to records. Comments and work notes appear in conversations in real time and users can update the record directly from the conversation.
- Drag-and-drop sharing of links, files, and records.

UI16 or UI15 is required to use Connect Chat.

This video demonstrates how to use Connect Chat.

This video demonstrates how to use Connect Support.

**Note:**

- Connect Chat does not replace legacy chat but offers some of the same functionality. The features should not be used concurrently.

**Connect Chat use**

All users have access to Connect Chat, a convenient way to stay updated on all the people and documents you work with in a familiar chat interface.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
You can start using Connect Chat right away with virtually no setup. Connect Chat supports a few different types of conversations so you can use it as a social tool or a quick way to follow specific records.

**Start a direct or group conversation**

You can start a conversation with one or more users in Connect Chat.

Role required: none

A conversation between two users is called a direct conversation. A conversation between three or more users is called a group conversation.

1. In the chat view of the Connect sidebar, click the plus icon (+) by the filter.
   A Connect mini window appears.
2. In the To field, enter the name of the user you want to chat with.
   Suggestions appear as you type.
3. Optional: Enter additional names to create a group conversation.
   You can add or remove group conversation members later. You cannot add members to a direct conversation after you create it.
4. Press the Enter key to shift focus to the message field.
5. Send a message to create the conversation.
   The conversation is added to the Connect sidebar for quick access.

**Follow a record in Connect**

You can follow a record in Connect Chat to track activity as it happens, in a familiar chat interface. When you follow a record, you become a member of a record conversation.

Role required: whichever role is required to access the record you want to follow in Connect

You must first activate the Connect (com.glide.connect) plugin to complete this task.

Any record conversation you create in Connect becomes a record feed in live feed, and vice versa. Unlike direct or group conversations, all messages in record conversations are comments or work notes.

Note: By default, record conversations are enabled for all tables that extend Task [task]. Administrators can enable record conversations for additional tables or disable them if desired.

1. Navigate to a task record.
2. Do one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Follow the record</td>
<td>a. In the form header, click Follow. The system adds you as a member of the record conversation, but does not open the conversation. You can open the conversation from the Connect sidebar.</td>
</tr>
<tr>
<td>Follow the record and open a chat mini window</td>
<td>a. In the form header, click the down arrow in the Follow button. b. Select Open Connect Mini. The system adds you as a member of the record conversation and opens it in a Connect mini window.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Follow the record and open the Connect workspace | a. In the form header, click the down arrow in the Follow button.  
b. Select Open Connect Full.  
The system adds you as a member of the record conversation and opens it in the Connect workspace, the full-screen view. |

The **Follow** button is relabeled **Following**.

3. Add comments or work notes to the record directly from Connect.  
Any comments or work notes added to the record appear in the record conversation. Likewise, comments and work notes you add to the conversation appear on the record.  
a) In the record conversation, by the text entry field, click the message type icon  
(b) Select **Comment** or **Work Note**.  
c) Enter a message.  
By default, record conversation messages are added as work notes.  

Note: If you add an attachment to a record conversation, it is attached to the underlying record as well.

Edit your notification settings for the record conversation.

**Edit basic conversation details**

In Connect Chat, you can customize the avatar, name, and description for a group or record conversation.  
Role required: none  
These details are not editable for direct conversations.  

Note: The name and description for a record conversation default to the record name and short description. However, editing the name or description for a record conversation does not change anything on the underlying record.

1. Open the a group or record conversation in the Connect workspace.  
2. Click anywhere in the conversation header to the left of the icons.  
A pop-up appears to edit conversation details.  
3. Edit the conversation image, name, and description as needed.  
4. Click **Save**.

**Add or remove conversation members**

In Connect Chat, any member of a group or record conversation can add or remove other conversation members. In a direct conversation with only two people, you cannot add members to the conversation after you create it.  
Role required: none  
1. Open a group or record conversation in the Connect workspace.
2. In the conversation tools to the right of the conversation pane, click the member list tab.

3. Do one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a member</td>
<td>a. Click Add Member to Group.</td>
</tr>
<tr>
<td></td>
<td>b. Use the search field to find and select a user.</td>
</tr>
<tr>
<td>Remove a member</td>
<td>a. Point to a member name.</td>
</tr>
<tr>
<td></td>
<td>b. Click the minus icon (-).</td>
</tr>
</tbody>
</table>

Create a Connect conversation from a Visual Task Board

Create a Connect Chat conversation from a Visual Task Board to collaborate with board members and keep track of activity as it happens.

Role required: none

When you create a conversation from a task board, all the board members become members of the conversation. The members are synchronized between the task board and the conversation. For example, if you remove a user from the conversation, the system automatically removes the user from the board as well.

1. Navigate to **Self-Service > Visual Task Boards**.
2. Open a task board.
3. In the board header, click the connect with board members icon ( ).
   The system automatically opens a record conversation for the board. Each board member becomes a member of the conversation.

Connect Chat administration

Administrators can configure various performance settings and features of Connect Chat.

**Note:** There are also settings that apply to both Connect Chat and Connect Support. For more information, see Connect administration.

Configure the email notification interval

The email notification interval determines how long the system waits before sending a Connect Chat email notification to an inactive user.

Role required: admin

The default interval is 3 minutes. You can change this value.

1. Navigate to **Connect > Administration > Properties**.
2. Locate the property called Number of minutes to wait before collecting unread messages and sending an email to offline users. (collaboration.email_interval) and set the value to a different number of minutes.
3. Click **Save**.
When an offline user is sent a Connect message, the collaboration.new_offline_message event fires. The system waits the amount of time provided in the collaboration.email_interval property, then triggers the collaboration.notify_offline_user and collaboration.notify_offline_user.group events (depending on if the conversation was peer to peer or a group conversation). The sysevent_email_action record listens for collaboration.notify_offline_user(.group) then builds an email notification containing all the messages from the last collaboration.email_interval minutes that the user has received in that conversation.

Enable record conversations for a table

Record conversations are enabled for all tables that extend Task [task] by default. You can configure record conversations for additional tables that extend Task.

Role required: admin

To create record conversations, users must have access to the Follow button in the form header. To show the button and thus enable record conversations for a table, the following conditions must be true.

- The live_feed dictionary attribute must be set to true for the table.
  - By default, live_feed=true for all tables that extend Task [task].
- The glide.live_feed.task_header_button property must be set to both or collaboration.
  - By default, glide.live_feed.task_header_button is set to collaboration.

1. Navigate to the list view of a table for which you want to enable record conversations.
2. Perform the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. Click the list title menu and select Configure.</td>
</tr>
<tr>
<td></td>
<td>b. In the Configure window, click Dictionary.</td>
</tr>
<tr>
<td>List v2</td>
<td>Right-click any column header and select Configure &gt; Dictionary.</td>
</tr>
</tbody>
</table>

The list of dictionary entries for the table appears.

3. Open the dictionary entry that has Type set to Collection.
   The Dictionary Entry form appears.
4. In the Attributes related list, click New.
   The Dictionary Attribute form appears.
5. In the Attribute field, enter Live feed.
6. In the Value field, enter true.
7. Click Submit.
8. Navigate to Collaborate > Administration > Properties.
9. Locate the property called Determine whether or not a button is shown in task forms to view the Collaboration document conversation or Live Feed Record Feed related to the task (glide.live_feed.task_header_button).
10. Ensure the property is set to both or collaboration.

The glide.live_feed.task_header_button property also controls whether the show live feed icon ( ) appears. If the property is set to collaboration, the show live feed icon does not appear on form headers.
Prevent users from following records in Connect for all tables

Users can follow records in Connect for any table that extends Task [task] by default. You can disable this functionality for all tables.

Role required: admin

To disable record conversations for all tables, prevent the Follow button from appearing in all form headers by editing the glide.live_feed.task_header_button property.

1. Navigate to sys_properties.list.
2. Locate the glide.live_feed.task_header_button property.
3. Set the Value to live_feed.

Prevent users from following records in Connect for a specific table

Users can follow records in Connect for any table that extends Task [task] by default. You can disable this functionality for a specific table.

Role required: admin

To disable record conversations for a specific table, prevent the Follow button from appearing in form headers for the table. To do so, set the live_feed dictionary attribute to false for the table.

1. Navigate to the list view of a table for which you want to disable record conversations.
2. Perform the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right-click any column header and select Configure &gt; Dictionary.</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and select Configure, and then select Dictionary.</td>
</tr>
</tbody>
</table>

The list of dictionary entries for the table appears.

3. Open the dictionary entry that has Type set to Collection.
   The Dictionary Entry form appears.
4. In the Attributes related list, locate the Live feed dictionary attribute.
5. Set the Value to false.
   Setting the dictionary attribute to false also removes the show live feed icon for the table.

Disable Connect Chat

You can disable Connect Chat to prevent users from being able to chat within the platform.

Role required: admin

Disabling Connect Chat hides the Connect Chat sidebar icon. Users who try to access Connect Chat from the navigation pane receive a message that says Connect has been disabled.

1. In the navigation filter, type sys_properties.list and press Enter.
2. Search for the glide.connect.chat.disabled property.
3. Set the property value to true.
Connect Support

Connect Support is a real-time messaging tool that enables support agents to easily keep track of their support cases, quickly find solutions, and resolve problems quickly.

Connect Support builds on the messaging platform provided with Connect. For general information about the Connect interface, setup, and administration, see Connect. When Connect Support is enabled, users designated as support agents have access to the support tab of the Connect sidebar.

Using Connect Support:

• Administrators can create chat queues and enable users to access live support.
• Support agents can monitor the queues to provide instant support.
• Users can share links, files, and records using drag-and-drop.

UI16 or UI15 is required to use Connect Support.

Note:

• Connect Support does not replace legacy chat but offers some of the same functionality. Do not use the features concurrently.

Monitor incoming Connect Support conversations

In the support tab of the Connect sidebar, you can monitor the queues for which you are an agent and accept incoming conversations.

Role required: none

Note: The support tab is visible only if you are an agent for one or more queues.

1. Navigate to Connect > Connect Support.
   The Connect workspace opens in a new tab.

2. Click the support tab of the Connect sidebar, indicated by a headset icon ( ).
   The support tab displays Queues to which you belong. It also displays your open support conversations under Cases. When a user starts a support conversation or an agent transfers
a conversation to a queue, any agent who belongs to the associated queue can accept the conversation. An agent can also request to transfer a conversation directly to you.

Support tab of Connect sidebar

3. Accept a conversation in one of the following ways.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept a conversation from a queue</td>
<td>Under Queues, click Accept by the queue. The conversation opens in the conversation pane and an entry appears in the Cases section of the sidebar.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Accept a transfer request</td>
<td>Under Cases, click <strong>Accept</strong> by a transfer request.</td>
</tr>
</tbody>
</table>

**Transfer request**

The conversation opens in the conversation pane. The agent who transferred the conversation can stay in the conversation.

4. **Respond to the user and help resolve the issue.**

   By default, your messages are added to the conversation record as comments and are visible to the user.

**Share knowledge in a Connect Support conversation**

The support view of the Connect workspace has a built-in knowledge tool that makes it easy to search for knowledge articles and share them in a conversation.

Role required: none

Use the knowledge tool to research user questions and provide solutions quickly and easily.

1. **Open a support conversation in the Connect workspace.**

   The knowledge tool is not available in Connect mini windows.
2. In the conversation tools area to the right of the conversation pane, click the knowledge base tab, which is represented by an open book icon.

The knowledge homepage appears in the conversation tools pane.

3. Search for articles related to the user's issue.
   For more information about finding knowledge, see Search using Knowledge Management v3.

4. To share an article in the conversation, drag a knowledge article link to the conversation pane and drop it anywhere in the drop zone that appears.
Transfer a Connect Support conversation to a different agent or queue

You can transfer a Connect Support conversation to a different agent in the queue or to a different queue.

Role required: none

1. Open a Connect Support conversation.
2. At the bottom of the conversation, click the menu icon (regation) to open the Connect actions menu.
3. In the Connect actions menu, select **Transfer**.

A transfer dialog box opens.
4. Do one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer the conversation to an agent</td>
<td>a. To start the transfer request, click <strong>Transfer</strong> by an agent's name.</td>
</tr>
<tr>
<td></td>
<td>Be sure to choose an agent who is online. A green dot on their avatar indicates that a user is online.</td>
</tr>
<tr>
<td></td>
<td>You can cancel the transfer any time before it is accepted.</td>
</tr>
<tr>
<td></td>
<td>b. When the transfer is accepted, select one of the following options in the dialog box that appears.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Stay</strong>: Remain in the conversation, which is also known as a warm transfer. This option is ideal if you want to provide the new agent with background information or introduce the user to the new agent.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Leave</strong>: Exit the conversation, which is also known as a cold transfer.</td>
</tr>
</tbody>
</table>

Transfer the conversation to a queue

Click **Transfer** by a queue.

The system automatically removes you from the conversation and the conversation enters the queue you selected.

Add a user to a Connect Support conversation

You can add additional users to a Connect Support conversation.

An administrator must enable the **glide.connect.support.add_members** property before users can be added to conversations.

Role required: none

1. Open a group or record conversation in the Connect workspace.
2. In the conversation tools to the right of the conversation pane, click the member list tab

( )
3. Do one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a member</td>
<td>a. Click Add Member to Group.</td>
</tr>
<tr>
<td></td>
<td>b. Use the search field to find and select a user.</td>
</tr>
<tr>
<td>Remove a member</td>
<td>a. Point to a member name.</td>
</tr>
<tr>
<td></td>
<td>b. Click the minus icon (-).</td>
</tr>
</tbody>
</table>

The assigned support agent cannot be removed from a Connect Support conversation.

**Note:** Only the assigned support agent can create an incident from the Connect Support conversation.

---

**Escalate a Connect Support conversation**

If an escalation path is defined for a Connect Support conversation, you can use a shortcut to escalate a Connect Support conversation to a different queue.

Define an escalation path for the queue, using the **Escalate to** field on the Chat Queue [chat_queue] table. For more information, see **Administer Connect Support queues**.

1. Open a Connect Support conversation.
2. At the bottom of the conversation, click the menu icon (≡) to open the Connect actions menu.
3. In the Connect actions menu, select **Escalate**.
   A confirmation dialog box appears.
4. In the dialog box, click **Escalate**.
   The system automatically removes you from the conversation and the conversation enters the escalated queue.

---

**Create an incident from a Connect Support conversation**

You can use a shortcut to create an incident on behalf of a user, directly from a Connect Support conversation.

**Role required:** none

You might want to create an incident if you cannot resolve the user's issue over chat or if you want to create a record of the conversation to share with the user. When you create an incident from a support conversation, the system copies the conversation history to the incident activity stream as comments and work notes. Future messages are tracked in the incident as well.

**Note:** Administrators can customize the behavior of the **Create Incident** Connect action. For more information, see **Administer Connect actions**.

1. Open a Connect Support conversation.
2. At the bottom of the conversation, click the menu icon (≡) to open the Connect actions menu.
3. In the Connect actions menu, select **Create Incident**.  
   In the conversation tools area to the right of the conversation, a new incident form opens in a record tab. The system automatically sets the **Caller** field to the user who opened the support conversation.

4. Complete the form as necessary and click **Submit**.  
   Any comments or work notes in the record conversation appear as comments on the incident form. 
   Work notes do not appear in the chat for the ESS user. The chat agent can select whether a message is a Comment or Work Note in the conversation.
   
   a) In the record conversation, by the text entry field, click the message type icon

   ![Message Type Icon](image)

   b) Select **Comment** or **Work Note**.

   c) Enter a message.

By default, record conversation messages are added as comments.

**Note:** If you add an attachment to a record conversation, it is attached to the underlying record as well.

The system automatically shares the record in the conversation, copies the conversation to the record activity stream, and references the record on the Chat Queue Entry [chat_queue_entry] table. Any new journal fields added to the record do not appear in the chat. The system also changes the document ID for the conversation to reference the incident number instead of the entry in the Chat Queue Entry table.

**Connect Support chat states**

Connect Support chats move through specific states.
Connect Support chat states

<table>
<thead>
<tr>
<th>Composite state</th>
<th>State</th>
<th>Definition</th>
</tr>
</thead>
</table>
| Active          | Waiting        | • Requester/end user enters a queue by sending a message. Agent has not yet accepted it.  
• Requester/end user rejoins a session that is in a Reopenable state. |
| Work in Progress|                | • Agent accepts a chat from a queue. Both requester and agent engage in a chat session.  
• Requester/end user temporarily leaves an ongoing conversation; requester or agent does not end the session; requester rejoins session. |
| Reopenable      | Closed Abandoned| Requester/end user clicks **End Chat** button before agent accepts the request.                                                        |
| Permanently closed| Closed by Client| • Requester/end user clicks **End Chat** button after agent accepts the request.  
• Requester/end user times out.                                      |
|                 | Closed Escalated| Agent escalates an ongoing conversation by performing the Escalate action from the menu icon.                                      |
|                 | Closed Complete| Agent ends the session.                                                                                                                   |

Connect Support administration

Administrators can configure various performance settings and features of Connect Support.

**Note:** There are also settings that apply to both Connect Chat and Connect Support. For more information, see **Connect administration**.

Migrate from legacy chat to Connect Support

Connect Support is an extension of Connect. Users designated as support agents have access to the support tab of the connect sidebar. Do not use Connect Support concurrently with legacy chat.

Before you activate Connect Support, inform your support agents to close out any existing chats.

Legacy chat uses a different field to determine which state a help desk chat is in. A fix script is included in the Connect Support plugin that circumvents this issue by closing out any existing help desk chat sessions. Manually closing out any existing chats before allowing this script to run helps prevent any loss of chat information.

If you do not close out existing help desk chats, your metrics and chat queue will not work accurately.

1. **Activate the Connect Support plugin.**
   
   When you activate the Connect Support plugin, the `glide.connect.support.enabled` property redirects the legacy chat URL to Connect Support.  
   
   For more information, see **Activate Connect Support**.
2. Hide the Social IT application.
   Activating Connect Support does not completely eliminate the legacy chat module. To prevent users from using the legacy chat, hide the Social IT application menu. For more information, see Enable or disable an application menu or module.

**Properties for Connect Support**

The Connect Support Properties page provides several configuration options specifically for Connect Support.

These properties are available for Connect Support.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Should Connect be used for handling chat queue entries&lt;br&gt;glide.connect.support.enabled</td>
<td>Disables or enables Connect Support. When the property is enabled, the Service Desk Chat button in the Employee Self-Service portal opens the conversation in Connect Support, rather than legacy chat. Additionally, the Support tab appears in the Connect sidebar.&lt;br&gt;• <strong>Type</strong>: true</td>
</tr>
<tr>
<td>Number of support conversations an individual agent can have at one time (-1 is unlimited)&lt;br&gt;connect.support.conversation_limit</td>
<td>Determines how many support conversations an individual agent can have at one time. When the value is set to -1, an agent can participate in an unlimited number of conversations.&lt;br&gt;• <strong>Type</strong>: integer&lt;br&gt;• <strong>Default value</strong>: -1&lt;br&gt;• <strong>Location</strong>: Collaborate &gt; Support Administration &gt; Properties</td>
</tr>
<tr>
<td>Show agent avatar in Connect Support conversations.&lt;br&gt;connect.support.show_agent_avatar</td>
<td>Determines whether an agent's avatar is shown in a support conversation (enabled). When the property is disabled, users see the agent's name only.&lt;br&gt;• <strong>Type</strong>: true</td>
</tr>
</tbody>
</table>

*Note: The Connect Properties page contains many general Connect properties that impact Connect Support.*
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connect.support.idle.delay</td>
<td>Determines how many seconds a user must be inactive in a support conversation before an idle countdown timer appears.</td>
</tr>
<tr>
<td>connect.support.idle.count_down</td>
<td>Determines how many seconds the idle countdown timer remains open after it appears. If the idle user does not dismiss the timer before the countdown completes, the system closes the support session.</td>
</tr>
<tr>
<td>connect.support.user.closed.conversation_limit</td>
<td>Determines how many closed conversations appear in a user's support conversation history. When the value is set to 0, all previous conversations appear in the history.</td>
</tr>
</tbody>
</table>

Administer Connect Support queues

You can define the support agents, default messages, schedule, and escalation path for each Connect Support queue.

Role required: admin

**Note:** Both Connect Support queues and legacy chat queues are stored on the Chat Queue [chat_queue] table. Do not use Connect and legacy chat concurrently.

1. Navigate to **Connect > Queues**.
2. Click **New** or open an existing queue from the list.
3. Complete the Chat Queue form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the queue.</td>
</tr>
<tr>
<td>Active</td>
<td>Not used in Connect.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment group</td>
<td>User group that contains the support staff for the queue. Any user in the group can view the queue in the Connect sidebar and accept chats. No other users can access the queue. This field must be populated.</td>
</tr>
<tr>
<td>Average wait time</td>
<td>Average time it takes for an agent to accept a chat in the queue. This value is automatically calculated. Do not manually edit.</td>
</tr>
<tr>
<td>Confirm problem</td>
<td>Not used in Connect.</td>
</tr>
<tr>
<td>Escalate to</td>
<td>Different queue to which an agent can escalate a chat. For example, there is a queue for high priority support chats. When a queue is defined in this field, agents can access the <strong>Escalate</strong> option in conversations.</td>
</tr>
<tr>
<td>Initial agent response</td>
<td>Message that users see when an agent accepts their chat. For example, <strong>Thank you for contacting support. We are looking into your question now and will be with you shortly.</strong></td>
</tr>
<tr>
<td>Not available</td>
<td>Message that users see when they attempt to start a chat outside the defined queue <strong>Schedule</strong>. You can use HTML to format the message and include links or media.</td>
</tr>
<tr>
<td>Question</td>
<td>Initial phrase that users see when they start a new chat in the queue. For example, <strong>How can I help you?</strong></td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule that defines when the queue is available. Leave the field blank to make the queue available all the time. Users cannot start a new conversation in the queue outside the schedule hours.</td>
</tr>
</tbody>
</table>

4. To review conversations associated with the queue, add the **Chat Queue Entries** related list and review the records for the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>How long the user waited and the result</td>
<td>Review information in the <strong>State</strong> and <strong>Wait time</strong> columns.</td>
</tr>
<tr>
<td>Who is actively helping employees in the queue</td>
<td>Review the names of agents in the <strong>Assigned to</strong> column.</td>
</tr>
</tbody>
</table>

### Make a Connect Support queue accessible to end users

To make a Connect Support queue accessible to end users, use the accepted URL format.

Create a queue. Create agents for the queue by assigning users to the assignment group associated with the queue.

Role required: admin

For example, you might create a module or add a link to a portal. The accepted URL format is `https://<instancename>.service-now.com/$chat_support.do?queueID=<sys_id>`.

1. Navigate to **Connect > Administration > Queues**.
2. Right-click the name of the queue to which you want to link.
3. In the context menu, select **Copy sys_id**. Follow browser instructions to copy the sys_id if browser security measures restrict this function.
4. Preview the support queue by navigating to https://<instancename>.service-now.com/$chat_support.do?queueID=<sys_id>.
5. Create a module or other link to the queue using the URL.

**Connect Support metrics**

Optional plugins provide a homepage and Performance Analytics dashboards, which contain helpful Connect Support metrics.

The reporting homepage is ideal for support managers who want a simple solution to track the recent performance of the support organization. The Performance Analytics dashboards provide a more full-featured solution for support managers who want to analyze trends over time.

Users with the admin role can activate the following plugins to use these features.

**Connect Support homepage and dashboard plugins**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect Support Manager's Dashboard [com.glide.connect.managers_dashboard]</td>
<td>Provides a homepage for Connect Support, and all required configuration records. Though the plugin name contains the term dashboard, the plugin does not provide functionality related to Performance Analytics dashboards. Homepages are similar to dashboards, but do not require Performance Analytics roles to view.</td>
</tr>
<tr>
<td>Performance Analytics - Content Pack - Service Desk Chat [com.snc.pa.chat]</td>
<td>Provides the <strong>Service Desk Chat Monitor</strong> dashboard, which analyzes key Connect Support metrics and indicators.</td>
</tr>
<tr>
<td>Performance Analytics - Context Sensitive Analytics for Chat [com.snc.pa.chat.context_sensitive_analytics]</td>
<td>Provides in-form analytics for Connect Support. These analytics are available as a related link on the Chat Queue Entry [chat_queue_entry] form, and also as the <strong>Context Sensitive Analytics - Chat</strong> dashboard.</td>
</tr>
</tbody>
</table>

**Note:** For more information about these plugins, including which other plugins they activate, see [Additional plugins for Connect Support](#).

**Use the Connect Support homepage**

Use the Connect Support homepage to view key indicators and metrics related to support conversations, queues, and agents.

Activate the Connect Support Manager's Dashboard plugin (com.glide.connect.managers_dashboard) to view this homepage.

Role required: chat_admin

The homepage is called **Service Desk - Chat**.

1. Navigate to **Connect > Support Administration > Reporting Dashboard**.

**Note:** Though the module name contains the term dashboard, the module does not provide functionality related to Performance Analytics dashboards. Homepages are similar to dashboards, but do not require Performance Analytics roles to view.

The Connect Support homepage, which is called **Service Desk - Chat**, opens.
2. Click a widget to drill down into its data.

Use the Connect Support dashboards
Use the Connect Support dashboards in Performance Analytics to understand trends in your support organization's performance over time.

Activate one or both of the following plugins, according to your analytics needs:

- Performance Analytics - Content Pack - Service Desk Chat (com.snc.pa.chat)
- Performance Analytics - Context Sensitive Analytics for Chat (com.snc.pa.chat.context_sensitive_analytics)

Role required: both chat_admin and pa_viewer

The Performance Analytics - Content Pack - Service Desk Chat plugin (com.snc.pa.chat) includes the Service Desk Chat Monitor dashboard, which contains the following tabs:

- **Chat Monitor By State**: Contains metrics related to closed support conversations.
- **Overview**: Contains several metrics related to support conversations, queues, and agents.
- **KPI Process**: Contains metrics that are key performance indicators (KPIs) of the Connect Support process, including the average queue response time, the average duration of support conversations, and the number of new support conversations per day.

The Performance Analytics - Context Sensitive Analytics for Chat plugin (com.snc.pa.chat.context_sensitive_analytics) includes the Context Sensitive Analytics - Chat dashboard. The dashboard contains additional metrics related to support queues, including the number of support conversations closed.

**Note**: You must license Performance Analytics to collect scores for the indicators on the dashboards. Without Performance Analytics premium, the dashboards display the indicators with no data.

1. Navigate to Performance Analytics > Dashboards.
   The last dashboard you viewed opens.
2. In the dashboard picker, under the Connect Chat group, select the dashboard you want to view.
3. View the indicators.

Configure the add support users property

To enable support agents to add users to a Connect Support conversation, add the glide.connect.support.add_members property.

Role required: admin

When the glide.connect.support.add_members property is added and enabled, support agents can add users to a support conversation. Any added user can also add other users. Only the assigned agent can create an incident from the chat. When non-support agents are added to a chat, the chat appears in their chat tab.

**Note**: Make sure you are in the Global scope when adding this property.

1. Enter sys_properties.list in the navigation filter.
   The entire list of properties in the System Properties [sys_properties] table appears.
2. Verify that the property does not exist by searching for the property name. If it does exist, update the property with the information in the following table.
3. Click New.
4. Complete the form as follows:
Out-of-the-box Service Desk Chat Performance Analytics Solutions

Performance Analytics Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from for your application with minimal setup.

**Important:** Set up and test Out-of-the-box Solutions on a sub-production instance before enabling them in production.

**Note:**
- Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.
- Out-of-the-box solutions and in-form analytics provide all the configuration records required to analyze default applications. Customize these records for use in your production environment.

To enable the solution for Service Desk Chat, an admin can navigate to Performance Analytics > Guided Setup. Click Get Started then scroll to the section for Service Desk Chat. The guided setup takes you through the entire setup and configuration process.

Connect Support and Service Portal

Use Connect Support in your portal to allow your users to ask questions or submit requests to support agents. You configure the instance options to control the appearance of your widget and how it functions.

The Connect Support and Service Portal integration creates a Connect Support widget that you can add to a page in the Service Portal.

Activate Connect Support for Service Portal

Activate the Connect Support and Service Portal integration plugin so you can add the Connect Support widget to a portal page.

Role required: admin

Activating the Connect Support and Service Portal integration plugin automatically activates the Connect Support plugin.

1. Navigate to System Definition > Plugins.
2. Search for and activate the Connect Support and Service Portal integration plugin [com.glide.connect.support.service-portal].

After activating the plugin, the Connect Support widget appears in the list of widgets under Service Portal > Widgets. Use Connect Support in a portal by adding the widget to any page within the portal. For more information on adding a widget to a page, see Create and edit a page using the Service Portal Designer.
Configure Connect Support widget instance options

You can control the appearance of your widget and how it functions by configuring the instance options.

Role required: admin

1. Navigate to Service Portal > Service Portal Configuration and open the Service Portal Designer.
2. From the Service Portal Designer, select the page you added the Connect Support widget to. If you have not yet added the widget to a page, see Create and edit a page using the Service Portal Designer for more information.
3. Click the edit icon in the corner of the widget to open the instance options menu.
4. Complete the fields using the following table. Depending on the functionality you want to add, you may not need to add all these fields. For example, if you include the Queue ID, you do not also need to include the Queue Name or the Queue URL.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Select a color for your widget from a list of common bootstrap colors. Themes control the overall color of a widget, but if you want your widget to be a specific color, you can select it from the list.</td>
</tr>
<tr>
<td>Queue URL</td>
<td>The URL for the Connect Support chat queue that you want questions to be directed to. For example, http://&lt;instancename.service-now.com/$chat_support.do?queueID=&lt;sys_id&gt;</td>
</tr>
<tr>
<td>Queue Name</td>
<td>The name of the queue you want the questions to be directed to. You can find a list of queue names in Collaborate &gt; Connect Support &gt; Queues.</td>
</tr>
<tr>
<td>Queue ID</td>
<td>The sys_id of the queue you want questions to be directed to. You can find this ID by going to the support queue and either copying the queue ID from the support link, or by selecting Copy sys_id from the context menu.</td>
</tr>
<tr>
<td>Message</td>
<td>The text for the button in the Connect Support widget</td>
</tr>
</tbody>
</table>
## Content Management System

The Content Management System (CMS) is a ServiceNow application that enables users to create a custom interface for the ServiceNow platform and ServiceNow applications.

The CMS application is powerful and flexible. Customers use it for a wide variety of projects, from creating entire websites to integrating with other products. The Content Management application is active by default.

This video provides an overview of the CMS application.

A CMS typically requires a systems administrator or a web developer to set up and add features. Non-technical users can use the CMS application as a tool for website maintenance. You also want to consider the timing of the addition of content management, and the maturity level of ServiceNow data. For more information, see CMS Planning.

Following are several CMS project ideas:

- Design a company-wide service catalog that offers a collection of services.
- Present a customized UI for a knowledge base.
- Create customized login pages, search pages, views of lists, tables, charts, or graphs.
- Design a complete website.
- Integrate ServiceNow with other company applications.
- Build a tailored self-service portal for end users that is in compliance with a corporate style guide.

### Example CMS sites

There are two common interface approaches within the ServiceNow community:

- An image and text-based interface similar to Amazon.com
- A search-based interface similar to Google

Both approaches have been used successfully. The approach you select depends on the needs of the people using the data and how easy it is to train them. While the two design philosophies are different, both approaches share the common goal of UI simplicity.

### Activating CMS

You must request the Content Management System (CMS) application from ServiceNow personnel. Instead of activating CMS, use Service Portal for new development. Service Portal is an alternative to CMS with a refined user experience, and is active by default in the base system. See Service Portal and Content Management and Service Portal.
Content Management design

Before building a website in the CMS, it is important to have a good understanding of what to build and who the audience is.

A high volume of content can heavily influence the look and feel of the site and the site hierarchy. When deciding the content, design for ease of maintenance for the people who take care of the system. This level of planning can be time-consuming, but is important.

Review website design prerequisites to help you set expectations, scope deliverables, and define reasonable timelines. Consider both the planning and execution of site design, to understand how sites are built, and to provide a working overview of the CMS.

Timing is important when considering the addition of content management. Successful deployments of the content management system usually take place after phase 1 processes (for example, Incident, Problem, Change, Catalog, and Knowledge) are in place. This is especially true if the team has limited website design experience. Waiting until phase 2 of deployment gives administrators time to work in ServiceNow and to understand how the organization uses the system and what business needs it meets.

Also consider the maturity level of data in the ServiceNow system. Depending on the ITIL processes used, content management is only useful and effective once the data within ServiceNow is established. Ensure that hierarchies, tasks, and workflows are well-defined. For example, before creating a catalog interface, confirm that the service catalog has been in place for some time, has been used, and contains data. The same is true for a knowledge management interface, particularly when high ratings or view counts define article placement on the page.

Content organization

Before you begin to build the CMS website, list all the content that you want to include and take the time to organize it.

A site created in CMS relies on two different types of content.
- CMS site information, such as site pages, images, and menus
- System information, such as knowledge base articles and catalog items

CMS content

Begin by listing all the content you want to host on the CMS pages. Examples include help pages, My Requests, My Approvals, and specific catalog items. Think about current solutions that you can implement immediately, and note ideas for future implementation phases.

Within CMS, you group pages to define the top-down menu structure. You establish a home or starting page, and other pages in the site reference the home page in the Parent Page reference field.

There are several ways to group, such as by audience or the purpose of the website. After listing the content to host, group it logically and identify a common name for each group, as shown in the following examples.

<table>
<thead>
<tr>
<th>IT environment groups</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Content built for</strong></td>
</tr>
<tr>
<td>End user</td>
</tr>
<tr>
<td>IT professional</td>
</tr>
</tbody>
</table>
General groups

<table>
<thead>
<tr>
<th>Purpose of site</th>
<th>Common name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports</td>
<td>Reporting Page</td>
</tr>
<tr>
<td>Help and knowledge</td>
<td>Knowledge page</td>
</tr>
</tbody>
</table>

System content

Organize the content so the interface is easy to navigate and understandable to the user. Determine the organization based on the data that you are leveraging, both in the CMS (using sites, parent pages, pages, and navigational menus) and throughout the rest of the system. For example, within the catalog you have "category," and in the knowledge base you have "category" and "subcategory." You can use these hierarchies with filtered lists for good search results.

Organizing CMS content logically is important for long-term maintenance of the site, however, the data typically comes from other ServiceNow applications. Communicate with the administrators for these applications, such as the knowledge base, service catalog, and business service portfolio. Work with them to offer the application data appropriately through the CMS pages you create. For example, the team that created the ServiceNow corporate website in CMS began by evaluating the naming conventions used in the corporate knowledge base.

Branding elements

Branding refers to the logo, name, colors, and symbols that identify an organization. It imposes consistency in design and use of terms. Your marketing department defines branding elements and can provide them to you as you plan your CMS pages. Consider how to incorporate the following branding elements.

- Logos
- Color palette
- Tag line
- Trademarked elements
- Graphics

Site design

During planning, consider providing a core set of features with a standard appearance throughout the site. The following web design elements are often used to create a consistent look.

- Page templates
- Navigation schemes
- Header
- Breadcrumbs
- Footer
- Forms
ServiceNow features

Analyze and organize the following ServiceNow features in your instance if you plan on using any of them with CMS pages.

- Account settings
- Email
- Workflow approvals
- Filters

Team member identification

Identify the team members who assist you with website design, branding, and development.

Engage team members for each listed function before you begin to build pages for the CMS website. Each function can be performed by the same or different people.

- Gather corporate style design guidelines.
- Define the written terminology and content for the site.
- Gather and define the site flow.
- Manage the CMS project as the webmaster. The CMS webmaster is responsible for executing the design and making the site work. The following skills are required:
  - Basic ServiceNow administration skills
  - HTML
  - CSS
  - Graphic design
  - Web design

After you identify the project team members, establish who is responsible to complete the tasks involved in building the CMS website.

- Determine who owns each page.
- Set a page update schedule so owners do not overwrite each other.
- Formalize content management processes, including content review and page updates.

Data preparation

It is important that there is enough data in the ServiceNow instance before you begin to build the CMS website.

Ensure that the necessary data and content are available in the instance by taking the following actions.

- Review the ITIL processes that you intend to implement in the CMS. Ensure that the data in the instance is a mature representation of the applications being used, for example, service catalog, knowledge management, and incident management.
- Review the defined hierarchies, such as the categories and subcategories for the knowledge base or service catalog. You use these categories to design the entry page into the application.

Corporate style guide

When you build a CMS website, you design the look and feel based on guidelines in the corporate style guide.
A corporate style guide provides detailed information for designing any corporate interface, including corporate websites.

**Corporate design team**

Many organizations have a web development team that designed the corporate website. Contact this team and involve the designers early in the planning, as they provide help and give their approval to the interface you design. Without approval, there is the risk of having to redesign the entire site because it does not adhere to the organizational guidelines.

**Corporate style guide**

A corporate style guide takes the guesswork out of designing the CMS website. The example style guide shown is defined down to the pixel. Creating a site with the style guide makes it easy to create clean CSS and HTML. Without the style guide, building the site can take a great deal of time.

**Design considerations**

Some modifications to the base design for forms may be necessary. The content area of any CMS design should be no smaller than 860px, or service catalog forms are clipped. The sample style guide entry specifies the content area to be 576px, which clips service catalog forms.
Columns and topics:

1. Navigation (levels 2–4)
2. Main content
3. Info snippets
Prototypes and rapid web design

Many user interface designers use prototypes and rapid web design techniques to visualize the final product before it is developed.

Design revisions are the most time consuming and expensive phase of site design. When the team analyzes and then uses prototypes to create pages, revisions to the published pages are minimal.

Develop the prototype and print it. Review the design with the appropriate team members and annotate the prototype, and annotate what to update on each page.

Define the following elements within the prototype.
- The site map for the entire site.
- A detailed prototype of every intended page, including elements such as links, link destinations, content, page names, and page descriptions.

Content Management navigation

After you design the hierarchical structure of the site, begin planning site navigation.

Consider the following as you plan site navigation.
- Placing navigation elements on every page.
- Locating navigation elements in the same place on every page.
- Using either text or images for navigation.
- Providing visitors with an easy way to understand where they are in the site, for example, with breadcrumbs or a specific color scheme.
- Adding a site map, which is a one-page, hyperlinked, hierarchical outline of the site.
- Providing a link to the home page from every site page, as visitors often enter the site on a page other than the home page.
- Designing navigation to help visitors find information quickly with as few clicks as possible.

In the CMS, navigation menus define your site navigation. Build menus as navigational blocks to create navigation paths. The menu chosen for the task depends on the size and complexity of your site. Available menu options include the following items.
- List menus
- Two types of tab menus
- Vertical, clickable list, usually placed on the left side
- Horizontal blocks
- Vertical blocks
- Super menu (a menu of menus)

System content management

Most of the content in a CMS site is managed in different locations throughout the system.

For example, if you are building a knowledge website, the pages and blocks exist in CMS, but the knowledge articles are authored and managed in the Knowledge application. The same is true for any other type of content you plan to leverage. It is important to take time to understand the table structure of data to become acquainted with content.

Links to content are typically static, however, take time to look at the document tree and review how field values are formatted for use within the CMS. To understand the information provided below, right-click within forms in the platform and select Show XML to view the document tree for the referenced table. To
see the table values for each field, right-click the form label and choose Show - (field name) or Configure Dictionary for reference.

Look at several internet news sites for ideas on how to format dynamic list data and also the full article detail. Research blog sites, shopping sites, and any other site you find easy to use, as layout and usability design can be time-consuming. If you find a site that inspires you, emulate it in your design.

- This New York Times example has two separate list formats.
- The CNN example has several list formats on the page.
- Several different list formats are used on the ServiceNow website.

**Knowledge articles - kb_knowledge table**

When you right-click and select Show XML on any form within the system, the document tree for the referenced database table becomes reference-able. Review the following selected subset of the document tree so you can acquaint yourself with the content readily available to your site design.

```
<kb_knowledge>
  <active>true</active>
  <author;display_value= "First Last Name" >Use this field value if author name is important</author>
  <short_description>Use this field value as the link to the full article detail</short_description>
  <description>Provide this field value as a 1-2 sentence summary of the article</description>
  <number>Unique ID can be leveraged in a number of different ways</number>
  <published>Published time stamp of the article</published>
  <rating>This field value provides a 1 to 5 star rating similar to iTunes</rating>
  <sys_updated_on>Add to supplement article published timestamp</sys_updated_on>
  <sys_view_count>8</sys_view_count>
  <topic>Useful field value in creating hierarchical breadcrumbs</topic>
  <category>Also useful in organizing articles hierarchically</category>
  <use_count>Use this similar to Facebook's "like" feedback, answer to the question was this useful</use_count>
</kb_knowledge>
```
Domain separation in the Content Management System

This is an overview of domain separation and the Content Management System. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Support: Data only

Domain separation in this application is supported at the Data only level, meaning it supports the data security model of separating visibility of data from one domain to another. To learn more, see Application support for domain separation.

Configure Content Management sites

Planning a CMS site involves obtaining resources, communicating with others about design, and gathering content.

Role required: content_admin or admin

The following steps are a high-level overview of how to set up a site.

1. Plan and design your content.
2. Create a site.
   The site is the container that holds all the content. To simplify your process, you can copy an existing site and edit its components. For more information on creating a site, see Create a site. For more information on copying a site, see Copy a site.
3. Add pages to the site.
   Pages contain blocks of information for the site. For more information, see Create a content page.
4. Create content blocks to customize the layout, headers, menu navigation, lists, and static and dynamic content.
   Content blocks are chunks of actual HTML that make up the content page. There are various content block types available to help with your customization. For more information, see Content blocks.
5. Add style to your site using themes, style sheets, and frames.
   Neither content sites or content pages reference style sheets directly. Configure them using the Themes or Style Sheets options. For more information, see Style in Content Management.

6. Test the site.
   After you create or modify a site, test the site to ensure that content displays properly and all links work correctly. For more information, see Test the site.

**Content sites**

A content site is a group of related content pages that have the same basic theme, layout, and URL suffix. Content sites are made up of a series of basic building blocks. The Employee Self-Service site is an out-of-box sample site that is included in the CMS activation. It provides existing, working examples or each CMS component, which you can use like a template to build your own site.

**Site components**

**Create a site**

Configure a site by either creating a new site with CMS or by editing a copy of either the ESS Portal or the Service Management Portal.

Role required: content_admin or admin
If you are creating a catalog site in CMS, follow the steps in Manage catalog sites in Service Catalog.

1. Navigate to **Content Management > Sites**.
2. Click **New**.
3. Complete the form.

Since you have not yet created pages, you cannot select the Home, Search, Login, and Gauge target pages. Add them to the site record after you create them.

### Site fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the site.</td>
</tr>
<tr>
<td>URL suffix</td>
<td>The URL suffix that identifies the site. The URL suffix is case-sensitive,</td>
</tr>
<tr>
<td></td>
<td>the suffix you enter impacts the CMS site URL used to launch the site. The</td>
</tr>
<tr>
<td></td>
<td>URL is incorporated into the URL as follows:</td>
</tr>
<tr>
<td></td>
<td>http://&lt;instance name&gt;.service-now.com/url_suffix/page.do</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Do not use portal and cms in the URL suffix. They are reserved</td>
</tr>
<tr>
<td></td>
<td>terms and return a Page not found if you use them.</td>
</tr>
<tr>
<td>Home page</td>
<td>The page to display when the user does not specify a page name in their</td>
</tr>
<tr>
<td></td>
<td>URL: http://&lt;instance name&gt;.service-now.com/url_suffix/</td>
</tr>
<tr>
<td>Search page</td>
<td>The page that displays search results when a user searches from any page</td>
</tr>
<tr>
<td></td>
<td>within the site.</td>
</tr>
<tr>
<td>Login page</td>
<td>The page to use for logging in to the site. If specified, users must log in</td>
</tr>
<tr>
<td></td>
<td>to access the pages on the site. If left blank, no login is required to</td>
</tr>
<tr>
<td></td>
<td>access the pages within the site.</td>
</tr>
<tr>
<td>Gauge target page</td>
<td>The page that displays gauge content. When the user clicks a gauge on the</td>
</tr>
<tr>
<td></td>
<td>new site, the gauge target page opens to show the gauge content. The gauge</td>
</tr>
<tr>
<td></td>
<td>target page replaces the CMS page in the current tab.</td>
</tr>
<tr>
<td>Title</td>
<td>A title for the site. The title can be the same as or different from the</td>
</tr>
<tr>
<td></td>
<td>Name.</td>
</tr>
<tr>
<td>Description</td>
<td>A full description of the site.</td>
</tr>
<tr>
<td>Default layout</td>
<td>The layout for pages to use by default. Any page in the site that has a</td>
</tr>
<tr>
<td></td>
<td>blank <strong>Layout</strong> field uses the layout selected in this field.</td>
</tr>
<tr>
<td>Default theme</td>
<td>The theme for pages to use by default. Any page in the site that has a</td>
</tr>
<tr>
<td></td>
<td>blank <strong>Theme</strong> field uses the theme selected in this field.</td>
</tr>
<tr>
<td>Simple catalog display</td>
<td>Selecting this option simplifies catalog pages in the site by hiding the</td>
</tr>
<tr>
<td></td>
<td>search bar, breadcrumbs, and the results per page choice list. It also</td>
</tr>
<tr>
<td></td>
<td>prevents you from adding attachments from record producers to your CMS site.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use external cart</td>
<td>Option to omit the default cart when rendering catalog pages within a site that contains catalog pages. Provide a catalog cart block somewhere on the site to allow users to make catalog requests.</td>
</tr>
</tbody>
</table>

Note: If you use an external cart, the no cart check box on a service catalog item has no effect. The external cart appears for all items.

4. Click **Submit**.

The following is the site record for the ESS Portal:
Copy a site

To create a new site quickly, you can copy an existing site.

Role required: content_admin or admin

The site copy option creates a complete standalone copy of the site and all its resources. If you are copying a site to create a second site, use this option after the first site is complete, tested, and production ready. This consideration is important because the blocks, CSS, and pages are duplicated to support the new site. There are various reasons why site copying is useful, such as site versioning, branding, or creating a backup.
Images are not included when you use the Copy Site option. They are stored separately in the sys_attachments table.

To copy just a few pages without duplicating all the resources (CSS, blocks, menus), use the page copy option. Page copy duplicates the page but not the resources used in the page. For more information, see Copy a page.

1. Navigate to Content Management > Sites > [Site Name].
2. On the Site form, click Copy.
3. In the dialog box that opens, type a name for the new site.

   This name is a prefix for all the site elements that are duplicated. Do not use Portal or CMS in the site name.

   A progress bar shows the copy process. When the process is complete, the Site form shows information for the new site.

Content Management security

There are several methods for securing CMS sites and pages. Site security is set in the Login page field on the site record. You can control if a page is public or private through the URL.

Every content page has its own URL that users can access outside of the platform. Depending on how the Login page or roles are defined, the URL may or may not be public.

- If the content page has no defined Read role or there is no defined Login page, any internet user can navigate to the URL and view the content page.
- If there is a defined Read role, then anyone who goes to the URL is asked to log in before they can view the site.
- If there is a defined Login page on the site record, all pages in the site are private.

Content Management URLs

The format for Content Management URLs is as follows.

```
<path to the instance> + /<site suffix> + /<page suffix> + .do
```

The <site suffix> is defined by the URL Suffix field on the site form. The <page suffix> is defined by the URL Suffix field in the page form. The URL suffix is case-sensitive.

For example, the page Austere - Site Entry has a site URL Suffix of austere and a page URL Suffix of entry. The constructed URL looks like the following URL.

```
<instance name>.service-now.com/austere/entry.do
```

If the site URL Suffix field is left blank, the <site suffix> is cms, as shown in this example:

```
instance.service-now.com/cms/page.do
```

If the page URL Suffix is left blank, the name of the page is used as shown in this example:

```
instance.service-now.com/austere/Page Name.do
```

Special characters in the name of the page have to be escaped.

Login pages instead of login rules

You set a login page on the site record to allow users to log in or out directly through the content site.

Login rules were used in earlier versions to dictate what users saw after logging in, based on their roles or permissions. Login rules still work, but their use is deprecated.
Configure CMS sites to use single sign-on (SSO)

To configure CMS to use SSO, make the view_content page private.

Because public pages do not require login, and CMS sites are public by default, CMS pages do not use SSO. Use the following procedure to turn off public-facing content pages and enable SSO.

1. Navigate to Public Pages [sys_public.list].
2. For the view_content page, set Active to false.

Content pages in CMS

Content pages are the core of the Content Management System. A content page is a web page that displays blocks of content.

Pages are built from content blocks and organized into sites. Pages display as regular webpages that are rendered in HTML. Constructing a content page requires a basic knowledge of HTML. Content pages are formed by arranging content blocks in predefined layouts. They can be used to present login pages, search pages, or ServiceNow content.

Create a content page

Pages are built from content blocks and organized into sites.

Role required: content_admin or admin

1. Navigate to Content Management > Sites.
2. Open the site to add the page.
3. In the Pages related list, click New.
4. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the page. Prefix each page name with the name of the site followed by a dash and the page function. For example, ESS - Catalog Detail and ESS - Search Results are page names within the ESS site.</td>
</tr>
<tr>
<td>URL suffix</td>
<td>The URL suffix that identifies the page. It is incorporated into the URL as follows: <a href="http://instance">http://instance</a> name.service-now.com/site/url_suffix.do</td>
</tr>
<tr>
<td>Parent page</td>
<td>The existing page that is the parent of the current page. Parent pages keep sections sortable on the site list of pages and are used to create breadcrumbs dynamically. Use CSS to define menus that give the Parent page context within the user interface.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Layout</td>
<td>The layout to use for the page. Layouts define dropzones where content blocks can be added to the page.</td>
</tr>
<tr>
<td></td>
<td>If this field is left blank, the page inherits the default layout of the site. If the site does not have a default layout, there is a single dropzone for the entire page.</td>
</tr>
<tr>
<td>Content theme</td>
<td>The theme to use for the page. Themes bundle CSS style sheets that are applied to all content within the page.</td>
</tr>
<tr>
<td></td>
<td>If this field is left blank, the page inherits the default theme of the site. Use the default theme unless the page requires a different set of CSS style sheets from the other pages in the site.</td>
</tr>
<tr>
<td>Frame buster</td>
<td>Select the check box to remove any restrictions placed by frames that contain the page. This way you avoid frame-within-frame issues that sometimes occur with improper linking.</td>
</tr>
<tr>
<td>Content site</td>
<td>The site associated with the content page. If you created the page from the related list in the site, the value defaults. The content site provides the <code>&lt;site_suffix&gt;</code> in the page URL, as follows:</td>
</tr>
<tr>
<td></td>
<td>http://&lt;instance name&gt;.service-now.com/site_suffix/page_suffix.do</td>
</tr>
<tr>
<td>Read roles</td>
<td>Users with the selected roles can view the page. Click the lock icon to select roles.</td>
</tr>
<tr>
<td>Model document</td>
<td>A document ID of a record to display by default.</td>
</tr>
<tr>
<td>Page status</td>
<td>The status for the page, such as Draft or Published.</td>
</tr>
<tr>
<td>Created by</td>
<td>The user who created the page. If your role has higher privileges than your user name and you enter your user name, the field defaults to the role. For example, if you are logged in as an Admin and you type your name, which has lower privileges, this field displays Admin.</td>
</tr>
<tr>
<td>Title</td>
<td>The title for the page. The title displays on the browser tab when the page is accessed.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a description of the page that displays for users when they access the page.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Add content to a page**

After you define the page settings, set the content of the page by adding content blocks. Setting content blocks is similar to how you add content to homepages.

Role required: content_admin or admin
Note: Do not add any type of report, such as a calendar, to iFrames. For more information on adding a report directly onto a page without using iFrames, see Embedding reports in Jelly.

2. Click Add Content.
3. Select a content block from the picker.
4. Select the dropzone where the content goes.
Create content blocks by adding one of the content blocks named *New [block type]* to the page.
Copy a page

Copying pages is an efficient way to avoid duplicating the same work and to create pages quickly from a guiding master template.

Role required: content_admin or admin

1. Navigate to **Content Management > Sites** and select the site.
2. Select the page to copy.
3. Click **Copy**.
4. Rename the page.

**Note:** Do not use service_catalog to rename a page. It is already a valid page in the system.

5. Edit the page fields.
6. Click **Update**.

Assign a page to a site

If you have created multiple sites, you can add pages from one site to another site.

Role required: content_admin or admin

1. Navigate to **Content Management > Sites**.
2. Select a site.
3. In the **Pages** related list, click **Edit**.
4. Select other pages to include in the site.
5. Click **Save**.
6. Update the site.

Add a page to an application

Homepages and content pages are not added automatically to update sets and applications. They must be manually added.

Role required: content_admin or admin

1. Navigate to **Content Management > Pages**.
2. Right-click a content page record.
3. Select **Unload Portal Page**.

   The page is added to the current application and to the current update set.

Configure a private UI page for CMS links

With single sign-on (SSO) in place, you can generate email links that take users directly to tickets and applications through the CMS interface.

Role required: content_admin or admin

You accomplish this procedure by creating a private UI page to redirect CMS links. Because the page is not public, it requires authentication and redirects to SSO appropriately.

1. Check that your CMS site is private by completing the following steps.
   a) Navigate to **Content Management > Sites > [Your Site]**
   b) Verify that the **Login page** field has a page listed.

2. Create a new UI page by completing the following steps.
a) Navigate to System UI > UI Pages.
b) Click New.
c) Enter a Name, for example, redirector.
d) Enter the following Adobe Jelly code into the HTML field.

```xml
<?xml version="1.0" encoding="utf-8"?><j:jelly trim="true"
xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null"
xmlns:g2="null"><script type="script/javascript">
window.location.href="${sysparm_uri}";</script></j:jelly>
```

The CMS now supports email links with following format:

http://<path to instance>/<UI page>.do?uri=/<CMS suffix>/<record type>.do%26sys_id=<record ID>

For example:

http://<instance name>.service-now.com/redirector.do?sysparm_uri=/ess/incident.do%26sys_id=46e3e949a9fe19810069b824ba2c761a

**Note:** If you are using SAML 2.0 update 1 for SSO, use the UI page saml_redirector instead of creating a new UI page. For example, an email link to a SAML 2.0 redirector page would use the URL format: http://<instance name>.service-now.com/saml_redirector.do?sysparm_uri=/ess/incident.do%26sys_id=46e3e949a9fe19810069b824ba2c761a.

### Content Management templates

Templates are content pages that are reused to provide a consistent look and feel.

Templates are useful when creating CMS sites for the following reasons.

<table>
<thead>
<tr>
<th>Create new pages rapidly without risk by copying pages</th>
<th>Using a template to create new pages saves time because you do not have to keep repeating the same steps.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provide a restore point for pages within the system</td>
<td>Have a working template available if something goes wrong in one of the blocks or in the theme CSS. It is often easier to start over from the template instead of trying to undo complex changes.</td>
</tr>
<tr>
<td>Provide a functional reference for editors on the site project</td>
<td>Having the template as a reference ensures that pages continue to conform to the style guide.</td>
</tr>
</tbody>
</table>

### Page templates

Every page that is part of the site needs a template.

### Critical page reference fields

When you build a new site, there are four page reference fields on the site record that are critical. Understanding these pages and how they are used helps you define page templates and site defaults.

- **Home page**: landing page for the site. A home page is mandatory.
- **Search page**: page that displays search results when a user searches from any page within the site. A search page is mandatory for your site to have a Search Results block.
• Login page: a standalone login page, which is useful to force authentication for the entire CMS site.
• Gauge target page: page used to display the drill-through content from a gauge. When the user clicks a gauge, the gauge target page opens showing the drill-through content for that gauge.

Critical page reference fields

Detail pages

Depending on the data or tables that you plan to use, you may need detail pages. These detail pages use one of the content types in the following list.

• Knowledge detail page: displays a full knowledge article detail (mandatory for a knowledge site).
• Incident page: detail page for an incident record.
• Catalog page: detail page for all items, content items, order guides, and record producers.

Templates for creating sections

There are two page templates you can use when creating sections:

• Parent page: keeps sections within large sites organized and sortable on the site list of pages. Parent pages are also used to create breadcrumbs dynamically.
• Detail page: differs from the parent page in that the content area displays a full article or detail instead of a selection of related content. Detail pages must have a Current Document block.

These pages are mandatory if you plan on accessing system data. For example, if you plan on showing the service catalog in your CMS, you need the following items.

• A service catalog content type that references the [sc_cat_item table].
• A detail page that provides the full view of the item.

New templates

If the base system sample site pages are not suitable, you can create a template from scratch. Create a page and then use it as a template. For more information, see Create a Content Page.

When you save a new template, include the word "template" in the page name.

Configure a master template

An easy way to create a master template is to copy the existing ESS sample site and customize it to suit your own needs. You can also configure a master template from scratch.

Role required: content_admin or admin

Follow these steps to create a single master page and generate all important components within the site.

1. Design a layout.
   Regardless of the interface, a site can be distilled into a few simple layouts.

2. Create a theme.
   The theme defines the structure of the layouts in CSS and the base styles, such as fonts and colors. For more information, see Design themes.

3. Build the common blocks.
   Pages are composed of content blocks. Most content blocks are reused on multiple pages. For the master template, build basic blocks such as a header, side navigation, and some basic content for the main content area of the page. More detailed content can be added later, but define content for reuse on many of the site pages here. For more information, see Content blocks.

4. Build a site entry page.
   Use the common content blocks you just created to design the first page that users see when they enter the site. For more information, see Create a content page.

5. Build a detail page.
   Design the detail pages to determine how pages such as knowledge articles, catalog items, and search results are displayed. You can build a detail page by copying the site entry page and adding additional content blocks. For more information, see Copy a page.

6. Assign the pages created to the new site.
   Create the site and apply the layout and theme to the site defaults. Then, navigate to the All Pages list and specify the master template site in the Site column for each of the master template pages. For more information, see Create a site.

Customize a copy of a page template

One good source for templates is the base system sample site. It is easy to copy pages and restyle them into new page templates to meet different business requirements.

The Employee Self-Service portal is provided as a working example and design template in the following procedure.

1. Navigate to Content Management > Sites > Employee Self-Service.
2. Select a page.
   For example, to copy the ESS sample site homepage, select Portal.
3. Click Copy.
4. Rename the page.
5. Right-click in the header and select Save.
7. Point your cursor to the content block to change and click the edit icon that appears on the right. For example, change the menus, alter the layout, or add a different logo.
8. Click Update.
9. Use the page in other sites you created by assigning pages to a site.

Content types

Content types provide site-specific control of how system data defined by templates is rendered.

In the site, one page displays a list of knowledge articles, and another page displays catalog items or incidents or a combination of the two. Different themes can be used for types of content and each theme can provide different user interaction. Content types define the pages that display content from a table. Each content type corresponds to a table.

Every type of document that the CMS displays has an associated content type. Changing the content type requires knowledge of Apache Jelly scripting. However, the common content types (such as service catalog or knowledge base) come in the base system. Content types can be associated with particular sites. This association allows different sites to use different detail pages for the same content type.

Content types define three features of associated documents.

- What does a link to one of these documents look like? For example, if a list of these documents is displayed on a page, how does each entry appear?
- What does a detailed view of one of these documents look like?
- What detail page is used to display the document? This decision is important and is often an area of confusion for new CMS users.

The document content type determines the page that a list of documents points to, the list itself does not determine the page. The content from a link is displayed in a detail content block on a page. The content type determines in which detail block on a page the document content is displayed.

For example, the list block Catalog Top 5 displays the top five items in the Service Catalog table [sc_cat_item]. Because the table is [sc_cat_item], the content type sc_cat_item controls how the Catalog Top 5 list is displayed. Clicking any item in the list displays the Service Catalog Detail page with the item displayed on it according to the detail template script. These content types are applied:

- in search results to link to the correct page.
- in the Current Document block to display the current record.
- in links on lists and other places that link to record types.

Several content types are available by default for tables such as Catalog Item [sc_cat_item], Gauge [sys_gauge], and Page [content_page].

Content type defaults that are set for CMS can be overridden for individual sites. Use the Content Types related list on the site record to customize content types.

Note: To learn more about the properties that affect use of content types, see the following topics in Instance Security Hardening Settings:
- #unique_487
- #unique_488

Configure a content type

Users with the content_admin role can create a content type.
Role required: content_admin or admin

1. Navigate to Content Management > Content Types.
2. Click New.
3. Complete the Content Type form.

### Content Type form

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select the table whose content will be rendered in Content Management.</td>
</tr>
<tr>
<td>Content site</td>
<td>Select the site that will use this content type.</td>
</tr>
<tr>
<td>Media type</td>
<td>Enter one of the following media types to use with this content type.</td>
</tr>
<tr>
<td></td>
<td>• doctype: UI15 desktop interface only</td>
</tr>
<tr>
<td></td>
<td>• m: Smartphone interface only (not for CMS use)</td>
</tr>
<tr>
<td></td>
<td>• tablet: Tablet interface only (not for CMS use)</td>
</tr>
<tr>
<td>Default detail page</td>
<td>Select which page loads after a user clicks a link.</td>
</tr>
<tr>
<td>Gauge page</td>
<td>Select which page is the drill-through target for any gauge. If you display a gauge on a CMS page, then clicking the links loads the page specified here.</td>
</tr>
<tr>
<td>Summary Template</td>
<td>Write an XML script that determines how the list is displayed in the list block, if the link is displayed in a list block.</td>
</tr>
<tr>
<td>Detail Template</td>
<td>Write an XML script that determines how to display the associated information after a user clicks the link.</td>
</tr>
</tbody>
</table>

### CMS gauge support

Gauges are a graphical way to display information from an instance.

A gauge might, for example, show a bar chart breaking down all open incidents by category. Gauges are fully supported within the CMS system. This means:

1. You can put a gauge on a CMS page
2. You can control what will happen when a user clicks on a cell within that gauge

**Put a gauge on a CMS page**

You have control over the gauges on a CMS page.

1. Bring up the CMS page in edit mode.
2. Click Add Content.
3. Select the gauge you want to add.
4. Place the gauge on the page in the desired location.

**Control what happens on a click**

Since a CMS system uses multiple pages you have to tell the system which page to use to display drill through content.
In the normal (non CMS) system, when you click a bar in a bar chart or a wedge on a pie chart, you drill through and your current screen is replaced with a list of records meeting the chart's criteria. For example, if you have a gauge of Incidents by Category and you click the bar labeled Hardware you drill through to a list of all incidents with a category=hardware.

Within the CMS system, there is a similar drill through mechanism at work, but you must manually specify which page to display.

There are two different models of the drill through, use an in-place target frame to receive the content, or use another page to display the content.

Using an In-Place Target

An in-place target is a named iframe on the same CMS page as the gauge. When the gauge is clicked, the drill-through content appears within that iframe rather than changing out the CMS page. The gauge (and the rest of the page other than the target) remain in place and active.

Using a Gauge Target Page

A gauge target page is a separate CMS page that is used to display the drill-through content from a gauge. When a gauge is clicked, the current CMS page is replaced with the gauge target page and the drill-through content is rendered within that second page.

- **Gauge Target Page**
  To set a site default, select Gauge Target Page, on the site configuration page. This page is used as the drill-through target for any gauges in the system that do not have a more specific gauge page specified in their content type.

- **Gauge Page**
  To set a content-type specific page, you can specify a Gauge Page, on a content type page. Any gauges for this type of content then use that page for any drill through.

  **Note:** The gauge target on a particular content type overrides the default, site level, gauge target.

- **Gauge Target block**
  A gauge target page is a normal CMS page, with one special requirement. Somewhere on that page, there must be a Gauge Target block. This market block tells the system where to output the drill through data.

View content types

The following is an example of where you might use Content Types.

This example uses the out-of-box Employee Self-Service (ESS) site as an example.

Role required: content_admin or admin

Use any out-of-box instance of a CMS site.

   The Issue Status, or incident_status CMS page contains two content blocks: Common Answer and Current Issues. These content blocks both use Content Types to render results.
This block matches the Common Answers section of the Issue Status page. The Table field describes the Content Type associated with Common Answers.

4. Use the link to view existing Content Types.

5. Click the Content Type to view the XML that determines how the list and record are rendered in CMS. The Default Detail Page field indicates a CMS page that displays a record selected from a List of Content block.

6. Click the Information icon next to the Default Detail Page, to go to that page.

7. From the Default Detail Page, under Related Links, click **Edit Page**.

   The Detail Block contains a content type formatter. When editing or viewing the page, it is looking for a URL to be passed to determine the record to display, which is why it says "Detail record could not be located".

8. Click the pencil icon to edit and view the Detailed Content block.

   The Type drop down list has "Show the page’s current document" selected, which indicates that the document_id must be passed to this block from the CMS pages, then it can display the record based on the content type listed in the document_id.

9. From the Common Answers block, on the Self Service page, select a record.

   The page opens with a URL similar to: https://<instance name>.service-now.com/ess/knowledge.do?

   sysparm_document_key=kb_knowledge,02255450d731310013ab49547e61038e

   The table sysparm_document_key=kb_knowledge and sys_id 02255450d731310013ab49547e61038e determine the record. The associated content type, kb_knowledge, renders the content on the Default Detail Page, Portal - Knowledge Detail / url_suffix=knowledge.

Content blocks

A block is a defined piece of content within the system that can be reused.

A content page is constructed by arranging customized blocks of content on a page. Content blocks are an important part of a CMS site. Existing content such as reports, gauges, and record lists are automatically available as content blocks and more can be created within the CMS.

After defining content blocks, use them on any content page by adding them to drop zones. For more information, see **Add content to a page**.

Create content blocks after sites and pages have been designed.

Configure a content block

To configure a content block, define it in the appropriate form.

**Role required:** content_admin or admin

1. Perform one of the following actions to create a content block.

   • Navigate to **Content Management** > **Blocks** > [Block type] > **New**. The form for creating the selected block type opens.
   
   • Navigate to **Content Management** > **Blocks** > **All** and select the type of content to create from the list.
   
   • Edit a content page and add a stub block of the desired content block type. Click the link in the stub block.

2. Complete the content block form and save it.

3. Add the content block to any content page.
View CMS block tags

A CMS block tag is used for advanced block creation and site flexibility.

Role required: content_admin or admin

It is constructed as <g:content_block> {{Jelly_Tags|Jelly}} and can be used in either of the following ways.

- Blocks: to display a block inside a block.
- Layouts: to display a block inside a layout.

The tag appears in the format, <g:content_block type="<type>" id="<sys_id>"/>

An example of the block tag is included in the ESS Portal sample site.

1. Navigate to Content Management > Design > Frames.
2. Click cms_admin_home_frame.
3. View the code.

```html
<div class="cms_administration_home">
  ${body}
</div>

<!-- Would you like to pivot off of parent page instead? try this snippet -->
<j:if test="${current_page.getParentPage().getURLSuffix()=='administration'}">
  <g:content_block type="content_block_menu" id="7afc342def002000914304167b2256ac"/>
</j:if>

The defaults use the page URL suffix to define sub menus

-->
<j:if test="${current_page.getURLSuffix() == 'administration'}">
  <g:content_block type="content_block_menu" id="7afc342def002000914304167b2256ac"/>
</j:if>
<j:if test="${current_page.getURLSuffix() == 'community_inspired'}">
  <g:requires name="ess.portal.globals.jsdbx" />
  <g:content_block type="content_block_menu" id="ccd4b8c7efb70000914304167b22566e"/>
</j:if>
</div>
```

4. To see what the page looks like, navigate to the ESS Portal administration page. For example, http://instance name.service-now.com/ess/administration.do.

Types of content blocks

Content blocks, which make up content pages, are reusable pieces of content defined within the system.

Each content block can be used for a different type of content.
Configure a header block
A header block is a visual element placed at the top of pages. It provides a place for branding and other important site-wide functionality.

Role required: content_admin or admin

Some of the options that are available in headers include, global search, text size toggle, menus for navigational purposes, and the user name with logout link.

1. Navigate to Content Management > Blocks > Headers.
2. Click New.
3. Complete the form.

Header form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the header block.</td>
</tr>
<tr>
<td>Background</td>
<td>Select a background for the header logo and menus.</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong> - No background is rendered.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Gradient/Image</strong> - Specify an image or gradient image to serve as the background.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Colored Bars</strong> - Specify colors for three different sections of the header, top, middle, and bottom.</td>
</tr>
<tr>
<td>Image</td>
<td>If <strong>Background</strong> is <strong>Gradient/Image</strong>, upload an image for the header block background. For gradients, upload a gradient image.</td>
</tr>
<tr>
<td>Top bar color</td>
<td>If <strong>Background</strong> is <strong>Colored Bars</strong>, enter a CSS color or color name to use as the background for the top menu.</td>
</tr>
<tr>
<td>Middle bar color</td>
<td>If <strong>Background</strong> is <strong>Colored Bars</strong>, enter a CSS color or color name to use as the background for the logo and text.</td>
</tr>
<tr>
<td>Bottom bar color</td>
<td>If <strong>Background</strong> is <strong>Colored Bars</strong>, enter a CSS color or color name to use as the background for the bottom menu.</td>
</tr>
<tr>
<td>Logo</td>
<td>Select a logo image. The image is also a link to the main page.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the block available for use.</td>
</tr>
<tr>
<td>Text</td>
<td>Type the text to display beside the logo.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Select the check box and type any scripted conditions to apply in the <strong>Condition</strong> script field that appears.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category to provide organization for the header block. The category also determines the detail page in which header block links open. Detail pages often display information in different ways.</td>
</tr>
<tr>
<td>Top Menu</td>
<td>Select a navigational menu block to use as a menu above the logo.</td>
</tr>
</tbody>
</table>
Create a navigation menu block

Navigation menu blocks enable you to create a menu of links to different content pages.

Role required: content_admin or admin

The following three objects define navigation menus.

- Menu block: The menu block defines the entire menu block and how it displays.
- Menu section: The menu sections define groups of links displayed within the block.
- Menu item: The menu items define the links within each menu section.

1. Navigate to Content Management > Navigation Menus.
2. Click New.
A gallery of available navigation menu blocks displays.

3. Select the desired menu block style.
4. Complete the Navigation Menu form to define the block.

### Navigation Menu form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the block.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of navigation menu, which determines how the links are displayed.</td>
</tr>
<tr>
<td>Frame</td>
<td>Select a border style for the navigation menu block.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Select this check box to enable the use of scripted conditions. If selected, the Condition and Logged On fields appear.</td>
</tr>
<tr>
<td>Logged on</td>
<td>Select this check box to display the navigation menu block only if the user is logged on. This field appears only if Conditional is selected.</td>
</tr>
</tbody>
</table>
Configure menu sections

Menu sections define groups of links displayed within the navigation menu block.

Role required: content_admin or admin

1. Navigate to Content Management > Blocks > Navigation Menus and select a block.
2. In the Menu Sections related list, click New.
3. Complete the Menu Section form.

### Menu Section form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the menu section.</td>
</tr>
<tr>
<td>Content block menu</td>
<td>Select the navigation menu on which this menu section appears.</td>
</tr>
<tr>
<td>Redirect to</td>
<td>Select what appears when a user clicks the menu section name and icon.</td>
</tr>
<tr>
<td>URL</td>
<td>Click the lock icon to open the edit field, then enter the URL to display when a user clicks the menu section title and icon. This field is available only if Redirect to is set to The specified URL.</td>
</tr>
<tr>
<td>Detail page</td>
<td>Select the content page to open when a user clicks the menu section title or icon. This field is available only if Redirect To is set to A content page.</td>
</tr>
<tr>
<td>Left image DB</td>
<td>Select the image database where your site images are stored.</td>
</tr>
<tr>
<td>Right image DB</td>
<td>Select icons to appear on the left and on the right of the name.</td>
</tr>
<tr>
<td>Left image</td>
<td></td>
</tr>
<tr>
<td>Right image</td>
<td></td>
</tr>
<tr>
<td>Second level text</td>
<td>Enter a description to appear beside the menu section title.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the menu section available for use.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number to indicate where this section appears on the menu relative to other menu sections.</td>
</tr>
<tr>
<td>Logged on</td>
<td>Select this check box to display the menu section only if the user is logged on.</td>
</tr>
</tbody>
</table>
4. **Click Submit.**

Configure menu items

Menu items are the links that appear within each menu section.

Role required: content_admin or admin

Not all navigation menu sections require menu items. Use menu items to link users to other pages or additional information. These steps use the ESS sample portal site as an example.

1. Navigate to **Content Management > Blocks > Navigation Menus** and select a navigation menu. For example, select the **Documentation Menu**.
2. From the **Menu Sections** related list, select a menu section. For example, select **Getting Started**.
3. From the **Menu Items** related list, click **New**.
4. Complete the form.

**Menu Item form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the menu item.</td>
</tr>
<tr>
<td>Menu section</td>
<td>Select the menu section in which this item appears.</td>
</tr>
<tr>
<td>Redirect to</td>
<td>Select what appears when the menu item name and icon are clicked.</td>
</tr>
<tr>
<td>URL</td>
<td>Click the lock icon to open the edit field, then enter the URL to open when the menu item title and icon are clicked. This field is available only if Redirect to is set to <strong>The specified URL</strong>.</td>
</tr>
<tr>
<td>Detail page</td>
<td>Select the content page to open when the name or icon is clicked. This field is available only if Redirect To is set to <strong>A content page</strong>.</td>
</tr>
<tr>
<td>Image</td>
<td>Select an icon to appear with the name.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the menu item available for use.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number to indicate where this item appears on the menu relative to other menu items.</td>
</tr>
<tr>
<td>Logged on</td>
<td>Select this check box to display the menu item only if the user is logged on.</td>
</tr>
<tr>
<td>Roles</td>
<td>Click the lock to open a list, then select the roles that can access this menu item to restrict access by role.</td>
</tr>
<tr>
<td>Category</td>
<td>Select the category in which the menu item belongs.</td>
</tr>
<tr>
<td>Open in</td>
<td>Select the behavior of clicked links.</td>
</tr>
<tr>
<td>iFrame</td>
<td>Type the name of the iFrame where the link opens when a user clicks the menu item name and icon. Make sure that there is an iFrame on the page. This field is available only if Open In is set to Named iFrame.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

Menu types

By changing the **Type** field on the navigation menu block, you can format the same menu in different ways.

**Menu types**

<table>
<thead>
<tr>
<th>Type</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Super Menu for Headers</td>
<td><img src="image" alt="Super Menu for Headers" /></td>
<td>The super menu is a hybrid between the drop-down menu and the tabbed system. The user can use a super menu to create a menu from any number of menus.</td>
</tr>
<tr>
<td>Type</td>
<td>Image</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Drop-Down Menu for Headers</td>
<td><img src="image1.png" alt="Image" /></td>
<td>The drop-down menu renders the menu sections as drop-down list. Use the mouse to point to the menu name and view the menu items.</td>
</tr>
<tr>
<td>Tab Menu for Headers</td>
<td><img src="image2.png" alt="Image" /></td>
<td>The tab menu renders the menu sections as tabs. Use the mouse to click the tab and view the menu items.</td>
</tr>
<tr>
<td>Horizontal Blocks</td>
<td><img src="image3.png" alt="Image" /></td>
<td>The horizontal blocks menu renders the menu sections as block headings with menu items as links within the blocks. The blocks are arranged horizontally.</td>
</tr>
<tr>
<td>Type</td>
<td>Image</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Tab Content Block</td>
<td><img src="image.jpg" alt="Image" /></td>
<td>The tab content block (horizontal) menu renders the menu sections as tabs with menu items as links within the block.</td>
</tr>
<tr>
<td>Vertical List</td>
<td><img src="image.jpg" alt="Image" /></td>
<td>The vertical list menu renders the menu sections as headings with menu items as links below them.</td>
</tr>
<tr>
<td>Vertical Blocks</td>
<td><img src="image.jpg" alt="Image" /></td>
<td>The vertical blocks menu renders the menu sections as block headings with menu items as links within the block. The blocks are arranged vertically.</td>
</tr>
</tbody>
</table>

Menu style customization

You can customize menu styles in the style sheets your site uses.

Navigate to **Content Management > Design > Style Sheets** to customize style sheets.
Supplementary page navigation menu example code

In the following example, look at the CSS class selectors and rules. Also, review how the block containers (div.cms_menu_section_blocks) are defined based on the outer container (TD.layout_content_submenu_column). The outer container is actually a part of the site layout.

This concept is clearer if you compare the styles to the styles used in the super menu further down in the example. This example shows that there is no need to make a completely new menu system. You can use CSS to change the look and feel of existing menus.

/*************************************************************************************************************************************************************/
SUB MENU VARIATIONS FOR HORIZONTAL MENUS - Section Blocks Menu
(cms_menu_section_blocks UI Macro)
*************************************************************************************************************************************************************/
TD.layout_content_submenu_column DIV.cms_menu_section_blocks {
  width: 156px;
  height: auto;
  float: left;
  position: relative;
  border-style: solid;
  margin: 0px 0px 0px 0px;
  border: 0px solid #e0e0e0;
  padding: 0px;
  background: none;
  padding: 24px 12px 0px 12px;
}

TD.layout_content_submenu_column DIV.sub_menu_section {
  width: 156px;
  height: 20px;
  float: left;
  border-style: solid;
  border: 0px solid #e0e0e0;
  padding: 0px;
  background: none;
  padding: 0px 12px 0px 12px;
}

SPAN.cms_sub_menu_list_link, TD.submenu_cell A {
  color: #FFF;
}

TD.layout_content_submenu_column IMG.menu_bullet{
  display: none;
}

TD.cms_menu_section_blocks_title h2, TD.cms_menu_section_blocks_title h2 a,
TD.cms_menu_tab_blocks_text h2 {
  margin:0;
  padding: 0px;
  font-size: 11px;
  text-transform: uppercase;
  color: #42C4DD;
  font-weight: normal;
  white-space: nowrap;
}

TD.layout_content_submenu_column a.cms_menu_block_item {
  margin:0;
  padding: 0px;
  font-size:11px;
}
Super menu sections example code

The following menu is a simple float grid. The defaults are written first. Then, below the "SUPER MENU VARIATIONS..." comment, the defaults are overwritten by adding a containing div with a unique class.

In the code that renders the header for the base system, the bottom menu resides in a table cell with the class of cms_header_bottom_menu (refer to the TD.cms_header_bottom_menu CSS selector).
4.2 2. Super Menu Sections Example Code

This menu is essentially a simple float grid. The defaults are written first. Then, below the "SUPER MENU VARIATIONS..." comment, the defaults are overwritten by adding a containing div with a unique class. In the code that renders the header for the base system, the bottom menu resides in a table cell with the class of "cms_header_bottom_menu" (note the TD.cms_header_bottom_menu CSS selector).

/ 
******************************************************************************************* 
Section Blocks Menu (cms_menu_section_blocks UI Macro)
******************************************************************************************* 

div.cms_menu_section_blocks {
    width: 260px;
    height: 260px;
    float: left;
    border-style: solid;
    margin: 0px 0px 12px 12px;
    border: 1px solid #e0e0e0;
    padding: 10px;
    background: url(blue/portal_horizontal_bkg.pngx) repeat-x center bottom;
}

p.cms_menu_separator {
    border-top:1px dotted #ccc;
    margin-top: 6px;
    margin-bottom: 6px;
}

td.cms_menu_section_blocks_title h2, td.cms_menu_section_blocks_title h2 a, td.cms_menu_tab_blocks_text h2 {
    margin:0;
    padding: 0px;
    font-size: larger;
    font-weight: normal;
    color:#444;
}

a.cms_menu_block_item {
    margin:0;
    padding: 0px;
    color:#999;
    font-size: inherit;
}
SUPER MENU VARIATIONS FOR HORIZONTAL MENUS - Section Blocks Menu
(cms_menu_section_blocks UI Macro)

TD.cms_header_bottom_menu .cms_menu_super_menu_bar { /*style the super menu drop down bar*/
  z-index: 199;
  float: left;
  background: none;
  margin-left: 44px;
}

TD.cms_header_bottom_menu div.cms_menu_section_blocks {
  width: 200px;
  float: left;
  border: 0px;
  margin: 0px 0px 12px 0px;
  padding: 0px;
  background: none;
}

TD.cms_header_bottom_menu p.cms_menu_separator {
  border-top:0px dotted #ccc;
  margin-top: 0px;
  margin-bottom: 0px;
}

TD.cms_header_bottom_menu .cms_menu_super_menu_bar_item { /*style an item on the super menu drop down bar*/
  z-index: 200;
  float: left;
  padding-left: 12px;
  padding-right: 12px;
  padding-bottom: 8px;
  padding-top: 4px;
  cursor: pointer;
  cursor: hand;
  font-weight: bold;
  color: #000;
  border-left: 1px solid #FFF;
  border-top: 1px solid #FFF;
}

TD.cms_header_bottom_menu .cms_menu_super_menu_bar_item_selected { /*style a selected item on the super menu drop down bar*/
  z-index: 200;
  float: left;
  padding-left: 12px;
  padding-right: 12px;
  padding-bottom: 8px;
  padding-top: 4px;
  cursor: pointer;
  cursor: hand;
  background: #fff url(super_menu_bkg.gifx) no-repeat left top;
  font-weight: bold;
  border-right: 0px solid #CCC;
  border-bottom: 0px solid #CCC;
  border-left: 1px solid #DDD;
  border-top: 1px solid #EEE;
}
Example menu items and content links

The method for choosing a link target (current window, iFrame, or new window) and referencing the item linked (page, attachment, or URL) are similar. Review examples of how to link within these elements.

- A content page reference helps you select the desired page. For example, the value `home.do` links to the site homepage.
- An attachment reference allows you to reference a single file attached to the menu item or section record. If there is more than one attachment, only the first attachment is referenced. The link is then generated automatically and displays a **Browser File Save** prompt.
- The specified URL reference allows you to link to a full URL string in your instance or from another system. For example, `com.glideapp.servicecatalog_cat_item_view.do?sysparm_id=66c313e7c0a8016b008ebela8e3d97f5&sysparm_nameofstack=b654d15bef921000914304` links to the **Ask a Question** record producer. Use this reference to link to a page in an existing intranet system.

Menu items can be seen as featured links from each section. There are many choices in URL definitions and link options. Links within the ESS Portal open content pages within the site. In turn, each page has an iFrame or set of blocks that houses the corresponding data. This method is useful for rapid prototyping, but consider where to create dynamic detail pages and use the available linking options.
Menu item

Menu items are similar to content links except they are called by the list block, not as part of a navigation menu block. Menu items and content links function the same as far as how they are defined and the options available for linking to items. Content links are meant to be called through a list block that calls the Content Link [content_link] table. Content links do not have the **Logged in** field or the **Roles** option used to control the UI experience for various roles.
Menu sections define groups of links and how the links behave.

Role required: content_admin or admin

For example, link behavior determines which page opens when the link is clicked and how it opens, such as in a new page or a new frame. Use the following procedure to view a sample menu section.

1. Navigate to **Content Management > Blocks > Navigation Menus**.
2. Click **Portal - Block Menu**.
3. In **Menu Sections** related list, click Order Things.
4. Click the reference icon next to **Detail Page** to open the page.
5. To view an example of dynamic content, follow these steps to look at the request catalog list/grid view on the ESS Portal.
   a) Add `/ess/manage.do` to your instance URL.
      For example, `https://<instance name>.service-now.com/ess/manage.do`.
   b) In the **Code Example Demos** section, click **Request Catalog List / Grid View**.
   c) Browse the catalog items.
Configure dynamic blocks
Use dynamic blocks to use scripting or to pull information from the system. Dynamic blocks are where most of your content resides.

Role required: content_admin or admin

A good use of dynamic blocks is job postings. Store the postings in knowledge articles and display the postings with a dynamic block.

Several dynamic blocks are predefined, including the following items.
- **New Content**: Each of the new content blocks allows for creating blocks while editing content pages.
- **Clean Login**: The default login page requesting user name and password, which includes a "Remember Me" check box. After the user logs in, this block triggers login rules.
- **Login**: An area that allows a logged out user to log in and a logged in user to log out. This block is especially useful on publicly available content pages.
- **Search**: The global text search field. Currently, global text search is the only form of search that can be included in a content page.
- **Search Results**: An area for displaying global text search results.

For information about Apache Jelly, see #unique_513.

1. Navigate to **Content Management > Dynamic**.
2. Click **New**.
3. Complete the Dynamic Content form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the dynamic content block.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category to provide organization for the dynamic block. The category also determines the detail page in which dynamic block links open.</td>
</tr>
<tr>
<td>Frame</td>
<td>Select a border styling for the dynamic block. For more information, see Format a frame.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the block available for use.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Enter any scripted conditions to be applied. If selected, adds a <strong>Condition</strong> script field to the form.</td>
</tr>
<tr>
<td>Two phase</td>
<td>Select this check box to allow two phase <strong>Jelly</strong> tags.</td>
</tr>
<tr>
<td>Dynamic content</td>
<td>Enter the XML script field that determines the behavior of the dynamic block.</td>
</tr>
</tbody>
</table>

Catalog cart block
The catalog cart block is a dynamic block provided in the base system.

This block provides the same cart that is available within the service catalog. If the **site definition** has the **Use external cart** option selected, include this block in the site so users can interact with their catalog cart.

Catalog cart block is available when the **glide.sc.use_cart_layouts** property is set to false.
**Customize the list block**

List blocks are content blocks that dynamically generate a list of links to records within the instance. When a user clicks a link in a list block, the associated information is displayed in a detail page determined by its content type.

Role required: content_admin or admin

Make the list using a simple query on any table or by scripting a more advanced query. Lists are powerful and flexible. Here are some places that allow you to have complete control over the list display.

**List control**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frames</td>
<td>Frames provide a method to create decorative containers for content blocks and other elements within the site. When frames are used with the <strong>Type</strong> field, the designer has complete control over list placement.</td>
</tr>
<tr>
<td>List Type</td>
<td>The List Definitions module defines the type of lists available for content pages. On the List Block form, select a list definition in the <strong>Type</strong> field.</td>
</tr>
<tr>
<td>List Filtering</td>
<td>Provides every field in the referenced table for more granular results.</td>
</tr>
<tr>
<td>Max Entries</td>
<td>Limits the results from a table to fit the design of the block.</td>
</tr>
<tr>
<td>Order and Order Direction</td>
<td>Allows sorting by any field in the referenced table, in either ascending or descending order.</td>
</tr>
</tbody>
</table>

You can also use list blocks to create a list of links to information outside your instance. Create the external links as records on the Content Link [content_link] table, and then follow the steps in this procedure.

1. Navigate to **Content Management > Lists**.
2. Click **New**.
3. Complete form.

**List Block fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the list content block. It is used to identify the record in the instance and is not displayed on the content page. Use the <strong>Title</strong> field for that purpose.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category to provide organization for the list content block.</td>
</tr>
<tr>
<td>Type</td>
<td>Select a list definition UI macro to format the list of links. For more information, see Configure list definitions.</td>
</tr>
<tr>
<td>Frame</td>
<td>Select a border style for the list block. For more information, see Create a frame UI macro.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to enable generating a list from a script, rather than from a simple filtered query.</td>
</tr>
<tr>
<td>Query</td>
<td>Filters the results using a condition builder.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the block available for use.</td>
</tr>
<tr>
<td>Title</td>
<td>Enter the name to display at the top of the list block when it appears in a content page.</td>
</tr>
<tr>
<td>Maximum entries</td>
<td>Set the maximum number of entries to display in this list block.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table to query for the list items. The table determines which detail page displays when a user clicks a link in the list block. For more information, see Configure a content type</td>
</tr>
<tr>
<td>Conditional</td>
<td>Select this check box to enable the use of scripted conditions. If selected, a Condition script field appears. Other fields that appear include the Logged On and Omit if empty check boxes.</td>
</tr>
</tbody>
</table>

Note: The list shows only tables and database views that are in the same scope as the list block.

4. Click Submit.

Configure list definitions
List definitions, similar to content management frames, are decorative containers that control the look and feel of lists.

Role required: content_admin or admin

Specifically, list definitions are UI macros that use Apache Jelly script to define how a list is rendered inside a list block. Site design often requires multiple list styles within the layout. Lists are often the primary form of navigation within a site, so it is important to have control over their formatting.

Configuring list definitions requires a knowledge of Apache Jelly.

1. Navigate to Content Management > Configuration > List Definitions > ..
2. Click New.
3. Complete the List Definition form.

Configure a static HTML block
Use static blocks for text that does not change. For example, use a static block for a site footer with only the company or organization name. A static HTML block allows any HTML code to be run within a page.

Role required: content_admin or admin

Anyone who edits their own HTML, Jelly, or Javascript may find the HTML editor in the static block limited. The HTML editor can also add tags or formats that advanced coders find unnecessary. For more advanced options, use dynamic blocks.

1. Navigate to Content Management > Blocks > Static HTML.
2. Click New.
3. Complete the Static Content form.

<table>
<thead>
<tr>
<th>Static content form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Category</td>
</tr>
<tr>
<td>Frame</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Conditional</td>
</tr>
<tr>
<td>Static Content</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

Format an image as a static HTML block
An easy way to add an image to a CMS page is to use a static HTML block. After the block is created, you can reuse it throughout the site.

Role required: content_admin or admin

1. Navigate to **Content Management > Design > Images**.
2. Click **New**.
3. Select a **Category** to help organize the images.
4. Type the file name of the image, including the extension (such as .png).
5. Upload the file by selecting **Click to add** and browsing for the image.
6. Click **OK**.
7. Click **Update**.
8. Navigate to **Content Management > Blocks > Static HTML** and click **New**.
9. Paste the following code into the HTML block, substituting the image name as uploaded in the previous step.
   The "x" at the end of the filename is required for image caching.

   ```html
   <img src="<image_name>.gifx"/>
   ```

Now the image is a static HTML block and you can add it to any content page. Use standard HTML code to alter the image in the content block.

Configure Flash movie blocks
Use a Flash movie block to embed any Flash movie (.swf file) as an attachment or by referencing a URL in a content page.

Role required: content_admin or admin
To add streaming video or Flash video (.flv), for example, to a knowledge article, see Embed videos in HTML fields.

1. Navigate to **Content Management > Specialty Content > Flash Movies**.
2. Click **New**.
3. Complete the Flash Movie form.

Flash Movie form

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the Flash movie block.</td>
</tr>
<tr>
<td>Source</td>
<td>Specify where the Flash movie is found.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Attachment</strong>: If this choice is selected, upload the Flash movie to this record.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Link to External Object</strong>: If this choice is selected, a <strong>URL</strong> field appears. Specify the Flash movie URL and ensure that the Flash movie is publicly accessible.</td>
</tr>
<tr>
<td>Height</td>
<td>Enter the height of the Flash movie in pixels.</td>
</tr>
<tr>
<td>Width</td>
<td>Enter the width of the Flash movie in pixels.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Configure content links**

Content links are the predecessors to navigation menus. You can use content links to create navigational links to information outside of your instance.

Role required: content_admin or admin

After the content link is configured, it must be defined in a list block. List blocks use content links to reference information outside of your CMS.

1. Navigate to **Content Management > Specialty Content > Content Links**.
2. Click **New**.
3. Complete the Content Link form.

Content Link form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the content link</td>
</tr>
<tr>
<td>Redirect to</td>
<td>Select the location of the external link</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category to provide organization for the list content block.</td>
</tr>
<tr>
<td>URL</td>
<td>Click the lock icon to open the edit field, then enter the site URL to open when the link is clicked. This field is available only if Redirect to is set to The specified URL.</td>
</tr>
<tr>
<td>Open in</td>
<td>Select the behavior of the clicked link.</td>
</tr>
<tr>
<td>Detail page</td>
<td>Select the page where the link opens when it is clicked. This field is available only if Redirect to is set to A content page.</td>
</tr>
</tbody>
</table>
4. Click **Submit**.
5. From **Content Management > Blocks > Lists**, create a list block that references the content links by selecting **Content Link** in the table field.
6. Create a query to determine which external links display on the page. For example, the query **Category is Search** displays any external links that have a category defined as **Search**.
7. Click **Update**.

Configure iFrames
An iFrame embeds a URL on a page within a frame. It can embed external pages or render ServiceNow content.

Role required: content_admin or admin
Configure an iFrame with forms you create in the instance and link to the page in which the iFrame resides.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the iFrame block.</td>
</tr>
<tr>
<td>Frame name</td>
<td>Type a name for the frame on the page.</td>
</tr>
<tr>
<td></td>
<td>When you use iFrames to present ServiceNow content such as forms or lists,</td>
</tr>
<tr>
<td></td>
<td>the frame name must be <code>gsft_main</code>. This name allows links within the iFrame</td>
</tr>
<tr>
<td></td>
<td>to open within the iFrame.</td>
</tr>
<tr>
<td>URL</td>
<td>Enter the URL to display in the iFrame. If you use the iFrame to display</td>
</tr>
<tr>
<td></td>
<td>ServiceNow content, start with the page name and do not include the base</td>
</tr>
<tr>
<td></td>
<td>instance part of the URL. For example, to show the list of requested items,</td>
</tr>
<tr>
<td></td>
<td>the URL is:</td>
</tr>
<tr>
<td></td>
<td><code>sc_req_item_list.do</code></td>
</tr>
<tr>
<td></td>
<td>Queries can be applied to the URL. For instance, to display a list of open</td>
</tr>
<tr>
<td></td>
<td>requested items, the URL is:</td>
</tr>
<tr>
<td></td>
<td><code>sc_req_item_list.do?sysparm_query=active=true</code></td>
</tr>
<tr>
<td></td>
<td>For more information, see <code>#unique_521</code>.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

Note: Do not add any type of report, such as a calendar, to iFrames. For more information on adding a report directly onto a page without using iFrames, see Embedding reports in Jelly.

Note: To deliver ServiceNow content from a web page, see Service Portal instead.

1. Navigate to **Content Management > Specialty Content > iFrames**.
2. Click **New**.
3. Complete the iFrame form fields.
Integrate Live Feed with CMS

You can provide access to Live Feed from pages built in the Content Management System (CMS). For example, allow an end user to access your company feed via the ESS portal.

The ESS Portal template includes the Portal - Live page and Live Feed dynamic block (requires the Live Feed plugin). To provide access to Live Feed from CMS pages, add the Live Feed dynamic block to a CMS page or include the Portal - Live page in a site.

1. Navigate to Content Management > Specialty Content > iFrames.
2. Click New.
3. Complete the iFrame block form with the following values.

   **Iframe values**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name: Live Frame</td>
</tr>
<tr>
<td>Frame name</td>
<td>Type a frame name: live_frame</td>
</tr>
<tr>
<td>URL</td>
<td>Enter <a href="https://instance">https://instance</a> name/live_feed.do?sysparm_doctype=true. Replace instance name with your instance URL, for example, &lt;myinstance&gt;.service-now.com.</td>
</tr>
<tr>
<td>Sizing</td>
<td>Select Fixed Size and enter height and width pixel dimensions according to the page on which you plan to display the feed. For example, enter a width of 1024 and height of 768.</td>
</tr>
</tbody>
</table>

4. Click Submit.
5. Complete the steps in Add the block to a page.

**Iframe methods**

The following examples show how system records are pulled into an iFrame that is placed on a content page.

For system lists or forms, use the frame name gsft_main so that links work properly.
• **Order Hardware** is an example of linking to a catalog category.
  • URL: `com.glideapp.servicecatalog_category_view.do?sysparm_parent=d258b953c611227a0146101fb1be7c31&sysparm_view=`
  • Frame name: `gsft_main`

• **My Approvals List** is an example of linking to a list with a view filter and a JavaScript that reference the authenticated user.
  • URL: `sysapproval_approver_list.do?sysparm_query=approver=javascript:getMyApprovals()&sysparm_view=ess`
  • Frame name: `gsft_main`

• **Service Catalog Home Page (system)** references the system catalog page within the Service Catalog application. If you are satisfied with the way the catalog looks, this method is an easy way to bring the page into a CMS design.
  • URL: `catalog_home.do?sysparm_view=catalog_default`
  • Frame name: `gsft_main`

• **Problem Management Overview** references a homepage. `../` makes the URL string relative to system homepages. Without it, the URL string resolves to the default CMS homepage reference in the site.
  • URL: `../home.do?sysparm_view=problem_overview`
  • Frame name: `gsft_main`

---

**Configure a detailed content block**

A detailed content block displays the content of an existing document, such as an incident, knowledge article, or service management request. The document type determines the page that a list of documents points to.

Role required: content_admin or admin

The block works with content types in the **Default detail page** field. For more information, see Configure a content type.

If you plan to use a script to find a document, configure the form to add the **Script** field if it is not displayed.

1. Navigate to **Content Management > Configuration > Page Detail Settings**.
2. Click **New**.
3. Complete the Detailed Content form.

---

**Detailed Content form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for the Detailed Content block.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category to provide organization for the detailed content block. If the block <strong>Type</strong> is <strong>Show the page's current document</strong>, the category displays content from any link of the same type.</td>
</tr>
<tr>
<td>Frame</td>
<td>Select a border styling for the detailed content block. For more information, see Format a frame.</td>
</tr>
<tr>
<td>Model Document</td>
<td>Select the document to display by default.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the block available for use.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Type | Select the behavior for the block.  
  • **Show a Specific Document**: Displays the Model Document.  
  • **Show the page’s current document**: Displays the currently selected document.  
  • **Use a script to find a document**: Uses the Script field to select a particular document.

Conditional | Select the check box and enter any scripted conditions to be applied. Selecting this check box adds a Condition script field and **Logged on** check box to the form.

Script | Enter a script to find an appropriate document if the Type is set to **Use a script to find a document**. Set the **Return** to the GlideRecord of the desired document.

---

4. Click **Submit**.

### Content Management and the Apache Jelly engine

Apache Jelly is a Java-based and XML-based scripting and processing engine for turning XML into executable code.

The Apache Jelly engine closely resembles XML and should be comfortable for developers familiar with JavaScript, XML, XHTML, or HTML. In the ServiceNow instance, the Apache Jelly engine renders items such as forms, lists, and UI Pages. Apache Jelly code renders well within a dynamic content block, but can have issues when used in static blocks. You can use Jelly tags, calls, and statements, but HTML acts just like XHTML.

```xml
<?xml version= "1.0" encoding= "utf-8" ?>
<j:jelly trim = "false" xmlns:j = "jelly:core" xmlns:g = "glide" xmlns:j2 = "null" xmlns:g2 = "null" >
  <j:if test = "${current_page.getName()=='Solutions'}" >
    <h1 class = "page_name" > <b> <a href = "solutions.do?" title = "${gs.getMessage('Solutions')}" >${gs.getMessage('Solutions')}</a> </b> </h1>
    <p class = "page_description" >
      ${current_page.getDescription()}
    </p>
  </j:if>
  <j:if test = "${current_page.getName()=='IT 3.0'}" >
    <h1 class = "page_name" > <b> <a href = "solutions.do?" title = "${gs.getMessage('Solutions')}" >${gs.getMessage('Solutions')}</a> </b> |
      ${current_page.getName()}
    </h1>
    <p class = "page_description" >
      ${current_page.getDescription()}
    </p>
  </j:if>
</j:jelly>
```

Ensure that all tags are closed. If the tag is not a naturally closing tag, then place a forward slash before the end bracket. For example, a `<BR />` or an `<IMG src="cms.png" />`.

If you are unfamiliar with Jelly scripting, review these topics:

- #unique_513
Include the following tag with all Apache Jelly scripts.

```xml
<j:jelly trim= "false" xmlns:j= "jelly:core" xmlns:g= "glide" xmlns:j2= "null" xmlns:g2= "null" >
```

The tag looks complex, but keep the following information in mind.

- **Apache Jelly script uses multiple namespaces.**
- There are two types of prefixes in tags: j and g. The j prefix is used for tags that are natively part of Apache Jelly. The g prefix is used for tags that the ServiceNow platform created and is using for platform purposes.

The j2 and g2 prefixes are just like j and g, except that they are processed in a second phase. The Apache Jelly script parser runs through each j and g tag respectively. For example:

```xml
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
  <j:set var="jvar_phase1" value="Hello" />
  <j2:set var="jvar_phase2" value="World" />
  ${jvar_phase1} ${jvar_phase2}
</j:jelly>
```

In phase 1, the parser runs through all the j and g tags. It then caches the result. Before it runs the second phase, it takes the j and g namespaces and moves the namespaces to the second phase. It looks something like the following code.

```xml
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide">
  <j2:set var="jvar_phase2" value="World" />
  Hello ${jvar_phase2}
</j:jelly>
```

For subsequent calls of this script, only phase 2 is parsed.

**Note:** If you plan to use phase 2 Jelly tags (g2 and j2) on the Content Type [content_type] or Dynamic Content [content_block_programmatic] tables, select the **Two phase** option on the content form.

Another example is to create a report of all open incidents assigned to each group. For this purpose, you could use a report and save time, but it is a good example for learning Jelly. Start with the Jelly tag:

```xml
<j:jelly trim="false" xmlns:j= "jelly:core" xmlns:g= "glide" xmlns:j2= "null" xmlns:g2= "null" >
</j:jelly>
```

First, you need a list of open incidents. Use a `g2:evaluate` tag. The evaluate tag runs the script. Anything inside the tag is parsed like a business rule, so, for example, you can call global business rules, script includes, and gliderecord.

```xml
<g:evaluate var="jvar_groups" object="true">
  var now_GR = new GlideRecord("sys_user_group");
  gr.orderBy('name');
  gr.query();
</g:evaluate>
```
This script is in phase 1 because frequent changes to incident assignment groups are not expected. Also notice the var attribute on the evaluate tag. This attribute specifies what variable is set from this block. At the end of the script, there is a gr on a line by itself. That last line is what sets the variable.

You can omit the jvar_groups variable, but then all the variables in the evaluate tag become Apache Jelly variables. The object=true specifies that the variable is not a primitive data type. If object=true is omitted, the script would break because jvar_groups would only be able to hold items like integers and strings.

After the evaluate tag, loop through these groups and find the incidents for each one.

```xml
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
  <g:evaluate var="jvar_groups" object="true">
    var now_GR = new GlideRecord("sys_user_group");
    gr.orderBy('name');
    gr.query();
    gr;
  </g:evaluate>
  <table>
    <tr>
      <th>Name</th>
      <th>Incidents</th>
    </tr>
    <j:while test="${jvar_groups.next()}">
      <tr>
        <td>${HTML:jvar_groups.getValue('name')}</td>
        <td></td>
      </tr>
    </j:while>
  </table>
</j:jelly>
```

You can include normal XML in the Apache Jelly script at any time. Since there is no namespace, the Apache Jelly script does not try to parse the XML tags. Notice the j:while loop. It is a normal while loop and can iterate through a GlideRecord object. Also notice that you output a value with ${HTML:jvar_groups.getValue('name')}.

Here are the important elements:

- The outer brackets, ${}, specify the output of the variable and the phase in which the variable is output: ${} means first phase, $[] means second phase.
- HTML before the expression is for escaping the output. The expression jvar_groups.getValue('name') is being escaped for HTML. For other types of escaping, there are JS (Javascript), NS (No Script), and some other options.

To select only one record and not iterate through many records, the code looks like the following example:

```xml
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
  <g:evaluate var="jvar_groups" object="true">
    var now_GR = new GlideRecord("sys_user_group");
    gr.orderBy('name');
    gr.query();
    gr;
  </g:evaluate>
  <j:if test="${jvar_groups.next()}">
    We found ${HTML:jvar_groups.getValue('name')}
  </j:if>
</j:jelly>
```
Content management and Jelly code examples

Code examples

**Header Example Code**

This dynamic content block needs to be active and have the "Two Phase" option clicked. The g:requires tag is including the UI script defined in the system whose name is "servicenow.website.globals". The file extension in the call is .jsdbx and is used only in the call to the UI script, not in the name of the script in the system. For JSDBX, the file being called is a JavaScript(.js) defined within the database (db) that needs to be cached (x).

```xml
<?xml version= "1.0" encoding= "utf-8" ?>&lt;j:jelly trim = "false" xmlns:j = "jelly:core" xmlns:g = "glide" xmlns:j2 = "null" xmlns:g2 = "null" &gt;
  &lt;g:requires name = "servicenow.website.globals.jsdbx" /&gt;
&lt;/j:jelly&gt;
```

**Page Title and Description Example Code**

This dynamic content block needs to be active. There are two actions within this code snippet. First is a forward-looking string container that allows site translation, the ${gs.getMessage('Your Text')} string call. The second action pulls in the page title and description, ${current_page.getName()} and ${current_page.getDescription()}.

```xml
<?xml version= "1.0" encoding= "utf-8" ?>&lt;j:jelly trim = "false" xmlns:j = "jelly:core" xmlns:g = "glide" xmlns:j2 = "null" xmlns:g2 = "null" &gt;
  &lt;j:if test = "${current_page.getName()=='Solutions'}" &gt;&lt;h1 class = "page_name" &gt; &lt;b&gt; &lt;a href = "solutions.do?" title = "${gs.getMessage('Solutions')}" &gt;${gs.getMessage('Solutions')} &lt;/a&gt; &lt;/b&gt; &lt;/h1&gt;&lt;p class = "page_description" &gt; ${current_page.getDescription()}&lt;/p&gt; &lt;br /&gt;&lt;/j:if&gt;&lt;j:if test = "${current_page.getName()=='IT 3.0'}"
  &gt;&lt;h1 class = "page_name" &gt; &lt;b&gt; &lt;a href = "solutions.do?" title = "${gs.getMessage('Solutions')}" &gt;${gs.getMessage('Solutions')} &lt;/a&gt; &lt;/b&gt; &lt;/h1&gt;&lt;p class = "page_description" &gt; ${current_page.getDescription()}&lt;/p&gt; &lt;br /&gt;&lt;/j:if&gt;&lt;/j:jelly&gt;
```

**List Block Pulling From Knowledge Articles Example Code**

This code example contains one of the best tricks in the CMS. Using the type field with draws from a number of defined list definitions to make slight, or very dramatic changes, to list display. Because the UI is open to configuration and innovation, this is a good opportunity to use design skills. Anyone who can use HTML and CSS knows that a basic list can be turned into a float grid or be made inline. The combinations are limited only by what the designer can dream up and code.

In the code example, there is a custom logo field (u_logo) added to the Knowledge form. The custom field displays customer logos, partner logos, and award images on the awards page. There are a number of different sections that use this list definition so efficient reuse is taking place.

- div class="cms_knowledge_list customer_success" - Begin by creating an outer container with a unique class name that can be used as a basis for CSS style selectors and rules. From the outer container, many of the child elements can be accessed for theming.
- g:for_each_record file="$(current)" max="$(jvar_max_entries)" - Loop for list creation that calls the selected table record and the entries set on the list form.
- a href="knowledge.do?sysparm_document_key=kb_knowledge,${current.sys_id}"<img src="$(current.u_logo.getDisplayValue())" alt="${current.text}" width="110px"/> - Defines linking to the...
article detail in the knowledge base. For further reference, look at content types within the site definition and you will see some similarities. The knowledge.do? portion of the URL points to the knowledge detail page which (as mentioned above) is mandatory if you plan to call the knowledge base in your CMS site. The rest of the URL represents the syntax for calling a knowledge article by its sys_id. Each and every item housed within the system has a unique sys_id.

- `<ttt>${SP}-${SP}${current.author.first_name}${SP}${current.author.last_name}</ttt>` - This example is commented out and not used, but it is still interesting in that it has a jelly call `${SP}` and it pulls the knowledge article’s author by first and last name.

```xml
<?xml version= "1.0" encoding= "utf-8" ?>
<j:jelly trim= "false" xmlns:j = "jelly:core" xmlns:g = "glide" xmlns:j2 = "null" xmlns:g2 = "null" >

<div class = "cms_knowledge_list customer_success" ><g:for_each_record file = "${current}" max = "${jvar_max_entries}" >
<tr><td class = "cms_knowledge_list_image" >
<j:if test = "${current.u_logo.getDisplayValue() != ''}" >
<div class = "knowledge_article_logo" ><a href = "knowledge.do?sysparm_document_key=kb_knowledge,${current.sys_id}" > <img src = "${current.u_logo.getDisplayValue()}" alt = "${current.text}" width = "110px" /> </a></div>
</j:if>

</td><td width = "100%" ><a href = "knowledge.do?sysparm_document_key=kb_knowledge,${current.sys_id}" target = "_top" ><span class = "cms_knowledge_list_link" >${current.short_description}</span></a><p class = "kb_description" >
"${current.description}"
</p></td><td width = "100%" colspan = "2" class = "kb_learn_more" ><p class = "kb_learn_more" >Learn More</p></td>
</g:for_each_record></div>

</j:jelly>

Style in Content Management

Content pages can be styled with CSS, just like any HTML website.

Three elements control CSS styles:

- **Style Sheets** are records containing CSS declarations.
- **Themes** are groups of style sheets that can be invoked together.
- **Frames** are UI macros that define the outer border of individual content blocks as they appear on a content page. Frames work by calling on particular definitions in the style sheets.

Style sheets

Styles sheets are standard Cascading Style Sheets (CSS) that define the look and feel of all elements within the interface.

Cascading Style Sheets (CSS) can either be internal (stored in the database) or external (hosted on the server), based on organizational needs. To define an internal style sheet, use standard CSS in the style field. Using external CSS allows the Content Management System to use the same CSS as a corporate website or other online resource.
Use an external style sheet by defining a URL that points to the .cssx file. If you upload a .cssx file to the platform, you can reference the .cssx file using a URL.

Content pages do not reference style sheets directly. To invoke a style sheet, you assign the style sheet to a Theme using the related list on the Theme form.

Design themes
Design themes are the convergence of structure and styling, making them a critical tool for creating a powerful user interface.

For a successful project, review the corporate style guide and communicate with the corporate website art team. If the organization has an art or design department that maintains branding, include them in this process.

A theme is a collection of one or more style sheets (CSS files) that define a consistent look for a set of pages. In most environments, many pages share a few themes. Use multiple themes within a site to create stylistic differentiators between site areas. You can also use a single theme to create one unified look and feel for the site.

Customize a design theme
A theme is a collection of one or more style sheets (CSS files) that define a consistent look for a set of pages.

Role required: content_admin or admin

Themes can be invoked in any of the following ways.
• Directly by content pages.
• As the default theme of a content site.
• On the configuration page as a global default.

1. Navigate to Content Management > Design > Themes.
2. Click New.
3. Type a name for the theme and mark it as Active.
4. Right-click the form header and click Save
   The Style Sheet related list appears.
5. Use the Style Sheet related list to add style sheets to the theme.

Doctypes
The view_content html page template on which all CMS is based defaults to doctype=html.

The code looks like the following HTML source code.

```
<!DOCTYPE HTML>
```

If your CMS site does not render properly, remove the doctype from the page by setting the following property:
• glide.html.doctype.pages =
  chat_desktop, live_feed, live_feed_small, navigator, navpage11, image_browse

The following is the default for this property.
• glide.html.doctype.pages =
  chat_desktop, live_feed, live_feed_small, navigator, navpage11, image_browse, view_content

Setting this doctype offers these benefits for building new sites:
• Incorporating common practice: Use a practice that is becoming widely adopted across the Internet and can prevent certain browsers from running in quirks mode.
• Cleaner CSS and markup: Write more standards-based CSS and markup to promote code sharing.
• A step towards browser compatibility: Find solutions that work across browsers and avoid browser-specific workarounds.

Format a frame

Frames provide a way to manage decorative containers for content blocks and any other elements within the site. For example, one frame can be a container, made of div or span tags, that is styled with rounded corners.

Role required: content_admin or admin

Individual content blocks use a frame UI macro to define the frames. When viewing a content block form, the Frame field offers a choice between the different frame UI macros. The frame UI macro does not, however, have the definition for the frame within its Jelly script. Instead, it references a particular frame as defined in a style sheet.

Configuring a new frame is a two-step process.
1. Define the frame in a style sheet.
2. Create the frame UI macro to invoke the frame definition.

Define a frame in a style sheet

Add style definitions for any custom frame UI macro you create.

Role required: content_admin or admin

Each frame has its own class name.
1. Navigate to Content Management > Design > Style Sheets.
2. Select a style sheet to contain the frame definition.
   Base system themes use a separate Frames style sheet.
3. Add the following code, substituting the desired frame name and style:
   ```
   div.FRAMENAME{border:STYLE;}
   ```
4. Click Update.

Create a frame UI macro

Copy an existing frame UI macro to display content in a custom frame.

Role required: content_admin or admin

Create a custom frame UI macro if you want to control the style of the frame with your own style sheet definitions.
1. Navigate to Content Management > Design > Frames and select one of the existing frame UI macros.
2. Change the name to match the FRAMENAME you used in the style sheet.
3. Right-click the header bar and select Insert and Stay.
4. Update the frame name in the XML field as shown:
   ```
   <div class="FRAMENAME">
   ```
5. Click Submit.

   • In any content block form, select the UI macro.
Define the frame in a style sheet.

**Content Management meta tags**

Meta tags are special tags in web pages that contain information about the page but are not rendered with the page. You can define custom meta tags for content pages.

Meta tags are not noticeable to a page visitor unless the visitor looks at the page source code. Web search engines read meta tags as they "crawl" the web, identifying and organizing content. Modern website designers often use meta tags to embed "hints" to search engines about how to index or otherwise crawl the site.

Structurally, a meta tag consists of a tag and a name/content pair and looks similar to the following code.

```html
<meta name="generator" content="MediaWiki 1.16wmf4" />
```

The Content Management System allows you to define both site level and page level tags.

**Configure a page level meta tag**

A page level tag is a meta tag defined on a specific page and included on only that page.

Role required: content_admin or admin

If an individual page has a specific tag with the same name as the site, the page tag takes precedence.

1. Navigate to **Content Management > Pages**.
2. Open the page.
3. If not already included, add the **Meta Tags** related list to the form.
4. In the **Meta Tags** related list, click **New**.
5. Type a **Name** and **Content** for the tag.
6. Click **Submit**.

**Configure a site level meta tag**

A site level tag is a meta tag is defined on a site and included on every page within that site.

Role required: content_admin or admin

If an individual page has a specific tag with the same name as the site tag, the page tag takes precedence.

1. Navigate to **Content Management > Sites**.
2. Open the site.
3. If not already included, add the **Meta Tags** related list to the form.
4. In the **Meta Tags** related list, click **New**.
5. Enter a **Name** and **Content** for the tag.
6. Click **Submit**.

**Configure DIV-based layouts**

After you create your site, you can change the site layout with DIV tags.

Role required: content_admin or admin

Many web page layouts use tables for a consistent look and feel. Tables are effective for numbers and statistics, but can be limiting for designing other types of information. DIV tags are flexible block-element tags. To use DIV tags for layouts, give the tag an ID and assign attributes using CSS.

Changing to CSS and DIV tags help in the following ways:
• simplify code
• reduce the amount of code
• increase page load speed
• separate content from presentation
• help pages adapt to different device resolutions
• make pages easier for search engines to crawl
• make code more compliant with evolving web page design standards

A theme named Administration Theme - Charcoal is included as an example of CSS-driven, DIV-based layouts. To view the Administration Theme - Charcoal DIV-based layout, complete the following steps.

1. Navigate to Content Management > Design > Layouts.
2. Click Admin 1 Column
3. Review the code.

Content meta tag hierarchy

Page and site level meta tags are included in a content meta tag hierarchy.

Site and page level tags

CMS supports page level and site level tags. The system behavior is to show the sum of all page level and site level tags. For example, if you have two tags on the site and one tag on the page, all with different names, you see three tags on the page. Two are from the site and one is from the page. If both the site and the page have a tag of the same name, only the page tag is used.

**Note:** The Content Management System does not support some commonly used meta tags. For example, you cannot use the X-UA-Compatible meta tag, which allows you to specify which version of Internet Explorer a site should be rendered in.

Example: all tags have unique names

<table>
<thead>
<tr>
<th>Site Level</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>breakfast</td>
<td>eggs</td>
</tr>
<tr>
<td>lunch</td>
<td>sandwich</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page Level</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>dinner</td>
<td>steak</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Output</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>breakfast</td>
<td>eggs</td>
</tr>
<tr>
<td>lunch</td>
<td>sandwich</td>
</tr>
<tr>
<td>dinner</td>
<td>steak</td>
</tr>
</tbody>
</table>

Example: page level tag overrides site level tag

<table>
<thead>
<tr>
<th>Site Level</th>
<th>Content</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Page Level</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>breakfast</td>
<td>eggs</td>
</tr>
<tr>
<td>lunch</td>
<td>sandwich</td>
</tr>
<tr>
<td>dinner</td>
<td>steak</td>
</tr>
</tbody>
</table>
Content Management integration points

Integration points use content blocks in CMS to link different applications together using static and dynamic methods.

By using integration points, users can connect to different systems from a single page. The power of the CMS is that it can display any data within the ServiceNow platform. The ESS portal, for example, connects users to a service catalog, a knowledge base, and a help and incident reporting site. Each section contains a set of links to additional content. List blocks offer the easiest way to display data dynamically. Content types define how lists link to the detailed data they reference.

Generating lists from the ServiceNow platform is straightforward, especially if you use filtering. When the CMS was first introduced, lists were the only method available to create navigational systems for sites. Content types define system record links using specific templates to define the list and the details.

- Summary template: defines the list
- Detail template: defines the detail as it is rendered in a page.

The templates work together to pass data attributes or unique record identifiers (sysid) into a single detail page that manages the data. Any attribute variations use the URL sent to the page.

Understanding how content types work can mean the difference between a site with 20 pages versus a site with 200 pages. There is a time for both types of data calls. Depending on the task, there are appropriate times to use static content and times for dynamic methods.

View links between system elements and URLs

You can view the links between your system elements and their URLs to render more specific content within your site.

Role required: content_admin or admin

See the #unique_521 page for an overview of URL syntax in the ServiceNow platform.

The Incidents list offers a quick example of viewing a form within its own tab. This viewing method illustrates how to append the URL string to render more specific content within your site.

1. Navigate to Incident > All.
2. Right-click in a blank area within the content frame and select **Open Frame in New Window** or **Open Frame in New Tab**.

The URL returned looks similar to this example.

```
<instance_name>/incident_list.do?
sysparm_userpref_module=b55b4ab0c0a80009007a9c0f03fb4da9
```

The URL is comprised of the following elements.

- `incident_list.do?` is the call to the list with no parameters passed into it. Explore context menu options and list filtering variations to see how the URL string is appended with each action.
- `incident_list.do?sysparm_query=&sysparm_view=ess` is an example of how the view is passed in the URL string.
- `incident_list.do?sysparm_query=GROUPBYactive&sysparm_view=` is how the URL looks when the **group by** option is chosen from the context menu.
- `incident_list.do?sysparm_query=category%3Dsoftware` is the result of applying a **category is software** filter to the list.

Explore all the options available within the right-click menu. Click through to the Incident form itself (incident.do) to see what the URL string does when parameters are passed into it.

**Element link examples**

View examples that show how to create a site pointing to various system data in several different data tables.

The following examples illustrate setting up access to the following system data.

- **Knowledge**: building a versatile front end for a knowledge base, from overview page to variations on the list definitions used in the site.
- **Catalog**: ideas for a business-to-consumer shopping experience that pulls various items and forms from your service catalog.
- **Service Portfolio**: using the business service portfolio to contain all defined services offered by your organization.
- **Featured reports**: methods for linking to the most important reports.
Example links to system data

Page source view

Use the tools available in your browser to view the frame source page and understand what URL address bars pass between system frame sets.

The Firefox browser, for example, has the developer tools option. This option provides an easy way to view records that render within the main content frame (gsft_main) of the ServiceNow platform. Also, Firefox quickly builds menus and links to records within the system.

This Firefox functionality is useful when stepping through the menu items section.
Static methods

Static methods in the CMS application were created for ease of use.

Form-based menu management and WYSYWIG code editing can be useful to both advanced and entry-level users. The technical ability of subject matter experts (SMEs) managing the language of your site can vary considerably. Letting SMEs write the content and having a technical resource manage the linking expedites menu and link creation within the system.
Static and dynamic methods

Navigation Menu Links

Use base system templates to group similar links for placement on the page. Though the terminology is different (menu sections and menu items), this type of linking behaves the same way as content links. For more information on creating a navigation menu block, see Create a navigation menu block.

Static HTML Details

Content blocks that are useful for areas administered by developers unfamiliar with HTML or markup. Anyone familiar with markup can use dynamic blocks because they are extendable. For more information on static HTML, see Using Content Blocks.

Content Links

The predecessors to navigation menus from when the CMS was first introduced. Use content links to make navigational links by defining several content links under the same category. Then, call the links as a list referencing the Content Link [content_link] table.

iFrame Details

Used both dynamically and statically throughout the system. Using them is an easy way to bring any form or list into your CMS pages. For more information on iFrame methods, see Using Content Blocks.
Dynamic methods

While static methods are a powerful navigational tool, you have more control over data rendering using the dynamic methods.

Reference common code in the system to make long-term maintenance of the site easier. Coding skills are useful when implementing dynamic methods.

Dynamic Blocks

These blocks are where the majority of your work resides. For more information, see Configure dynamic blocks.

Frames

Frames are meant to be decorative wrappers around any block in the system. They are mentioned with dynamic blocks because frames are essentially UI macros with the category of Frame. Frames apply the ${body} variable to a block and define where the block is inserted when rendered on the page.

Lists
Lists generate links to records based on the filtering rules you define. Lists can be sorted for presentation by any field in the corresponding record. Lists help supplement navigation and pull data from outside the CMS. For more information, see Customize the list block.

Content Types

Content types provide site-specific control of how system data defined as templates is rendered. The rendering of lists is considered first (summary templates). The next consideration is the detail template, which allows control over the record rendering.

List Definitions

List definitions enable you to extend the summary template defaults defined on the site level. Used with frames, list definitions render the same data differently based on the placement on the page or site. For more information, see Configure list definitions.

Detailed Content

Detailed content in page detail settings) are blocks that display the content of an existing document as a block on a content page. For more information, see Configure a detailed content block.

Example integration points

Each element on the page links to a specific URL point.
- **Target page frame name:** gsft_main
- **Desktop Computing URL:** category_browse.do?category=Desktop Computing
- **Business Applications URL:** category_browse.do?category=Business Applications
- **Communications Services URL:** category_browse.do?category=Communications Services
- **Infrastructure Services URL:** category_browse.do?category=Infrastructure Services
- **Hosting Services URL:** category_browse.do?category=Hosting Services

**Featured Services** links to a content page which pulls a small subset of services into an iFrame.
- **iFrame URL:** com.glideapp.servicecatalog_category_view.do?
sysparm_parent=d67c446ec0a8016500335aa37eafbc1&sysparm_view=
- **Frame name:** gsft_main
  - **Install Software URL:** catalog.do?
    uri=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=10d69689c611227600ffe5a41c664824
  - **Email Account URL:** catalog.do?
    uri=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=d67a86b6c0a80165009386c75cd4a09
  - **Electronic Messaging URL:** catalog.do?
    uri=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=533798810a0a0b2600f1a03593e19058
  - **VPN RSA Token URL:** catalog.do?
    uri=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=d67b099ac0a80165019d77252
  - **Shared Storage (SAN) URL:** catalog.do?
    uri=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=cedd458a0a0b8300c3b1e32e7a3ac2

**Reporting** links to a content page that pulls the reports page into an iFrame. All links within this menu leverage homepages in the system, which creates an issue with the home.do URL. Notice in the following links that ./ is used to create a relative URL outside of the CMS site home.do definition. Without this path, the site homepage would render within the iFrame.
- **iFrame URL:** report_home.do
- **Frame name:** gsft_main
  - **Cost Management Overview URL:** ../home.do?
sysparm_userpref_homepage=fa81ae91c0a805c64c0942ab2e4b852b
  - **Administration Overview URL:** ../home.do?
sysparm_userpref_homepage=8b7b11f6c611228901ff3fcfbd3cc8f
  - **Portfolio Overview URL:** catalog_home.do?sysparm_view=business
  - **Service Availability URL:** ../home.do?
sysparm_userpref_homepage=8ee772000a0a0bad00c38eb7e68b93d0
  - **Service Level Agreements (SLA) URL:** ../home.do?
sysparm_userpref_homepage=757e86a30a0006d401a6851639498d1

**Content Management testing**

Test your site to ensure that all pages display correctly, links go to the specified address, and images are not broken. It is important to test the site as you build it. Do not wait until just before launch to begin testing.
Also, test templates as you create them so any issues are resolved before creating other content based on the templates. Recruit as many people as possible to help you test.

Here are some general site testing guidelines:

- Test on the browsers and platforms your site visitors use
- Test on various monitors (for example, LCD and CRT)
- View pages using different screen resolutions
- View pages using different color settings
- Test all navigation and links
- Test items that can be downloaded (for example, PDF files)
- Test the search functionality
- Test site security
- If necessary, test for accessibility (for guidelines, see the W3C Website Accessibility Initiative)

**Global search in Content Management**

When you add global search to a CMS site, two different search result blocks can display, depending on the user role: global or no global.

Roles are defined at System Properties > Global Text Search.

- Search Results (Global): For users with permission to use the global search within the normal frame set. The normal frame set is defined as the default, non-CMS user interface with the set of frames.
- Search Results (No Global): For users without permission to use the global search. Searches only the knowledge base and the catalog.

The header search bar and the Search dynamic block in the base system both automatically handle the permissions and direct the user to the appropriate search results. In the base system, the search result blocks are deployed on the same Search Results content page.

In order for the global search to work properly, it is important to ensure that the DEFAULT directs users to a working content page. If not, the results from the global search link back to the frame set, not to pages within the CMS site.

**Note:** The global search is similar to the normal frame set user interface and ties to the same roles (#unique_541).

**Search Results (Global)**

Before you use the Search Results (Global) dynamic block, define content types to control the behavior a search result is clicked. If no content type is defined for a table, selecting a link on that table renders the results according to the DEFAULT content type. It is good practice to point the DEFAULT content type to a page with a normal "Current Document" detailed block. Set the content type detail (Detail Template field) to have just an iFrame.

The Search Results (No Global) dynamic block does not require any additional configuration.

**CMS translation**

You can translate CMS sites by activating internationalization plugins and manually translating custom interface strings.

Two tables support the translation of a CMS site into other languages.
• Translated Name / Field [sys_translated]: Stores strings that are shared or commonly used within a site. These include menu section names, menu item names, site breadcrumb names, link names, and footer menu links. Internationalization plugins typically provide translations for these strings. See Localization settings.
• Translated Text [sys_translated_text]: Stores unique string translations which you create when you manually translate interface elements. See #unique_544.

**View a translated CMS site**

Activating an internationalization plugin provides a quick way to see translated strings for CMS menus, breadcrumbs, and links. For a full translation, you must translate the instance manually.

The following example explains how to view a translated site in Japanese.

1. Navigate to **System Definition > Plugins**.
2. In the **Go to** filter, select **Name**, enter **I18N**, and then press the Enter key.
3. Activate both the **I18N - Japanese Translations** and the **I18N: Knowledge Management Internationalization Plugin v2** plugins.
4. Refresh the browser.
5. In the **Language** picker in System Settings, select **Japanese**.
6. Browse the site to see the translated language strings.
7. Navigate to the ESS Portal. The path is: http://Instance Name.service-now.com/ess/.
8. Browse the site to see the translated language strings in the ESS Portal.

**Credentials and connection information**

Credentials and connection information are required to gain access to a computer or network device for Discovery, Service Mapping, and Cloud Management or to perform work using Orchestration. When adding content to Share or AppStore, you can configure connections and credentials relevant to your environment without modifying built content.

**Explore**

- Upgrade to New York
- Introduction to credentials, connections, and aliases
- Getting started with credentials
- Domain separation for Credentials and Connections
- Credential affinity for Discovery and Orchestration

**Set up**

- Create and test your credentials
- Check IP service affinity for Discovery and Orchestration
- Prepare network connections for MID Servers

**Integrate**

- External credential storage
- CyberArk credential storage integration

**Troubleshoot and get help**

- Credentials troubleshooting
- Search the HI knowledge base for known error articles
- Contact ServiceNow Technical Support
Introduction to credentials, connections, and aliases

All application integrations in the ServiceNow platform use connection information, credentials, and aliases to enable their respective applications to access resources.

Before you can execute an application integration in your instance, you must create and configure the corresponding connection information and credentials. Connections pertain to an integration with a system, such as an IP address or endpoint with protocols. It contains specific details, such as database particulars, when integrating with a database. The associated credentials are the authentication data required to make the connection.

Connection information and credentials can vary between QA/Development/Production environments for the same integration. The tight coupling between this data and application metadata, such as workflow or job scheduling, make application metadata obsolete when you change environments. To alleviate this problem, the concept of an alias is introduced, to decouple connections and credentials from application metadata. These aliases allow customers to design their application metadata to pair with an alias, which resolves to connection and credential data during runtime.

There are two types of aliases, a connection and credential alias and a credential alias. Business rules enforce certain constraints on these aliases. Names must contain letters, numbers, and underscores, but cannot use special characters. The alias must be unique in a scope. If you choose to have multiple active connections, you can have more than one active connection in the same domain. If you do not choose this option, you can have only one active connection per domain.

Note: If you enable multiple active connections, the application picks one connection based on an established order. This order depends on the API you use to retrieve connection data.

You can add additional connection attributes to an alias, which are available in connection data during run time. Variables overridden by connection administration during run time should not affect the alias.

The credential alias resolves only credential data. Along with the alias data model, you can use a scriptable API that gets connection and credential data at runtime.

Upgrading credential tags

The upgrade process migrates credential tags to credential aliases. All credential tags in the Credentials [discovery_credentials] table have a corresponding credential alias with this information:

- **Name**: Unique alias name
- **Scope**: global
- **ID**: Alias name

Note: The credential tag field type changes from string to GlideList in the Credential table and the credential alias field refers to the created alias records.

Credential synchronization on MID Servers

Each MID Server in your network synchronized with the instance keeps a copy of every credential that you create. This synchronization speeds up the reading of credentials when applications like Discovery or Service Mapping need to access multiple devices on the network. The MID Servers synchronize when they find a credentials_reload job in the ECC Queue. The reload job instructs the MID Server to make a SOAP call to the instance to get the entire list of credentials in the Credentials [discovery_credentials] table, including all the field values.
The SOAP response that your instance sends to each MID Server also includes custom fields that you added to any credential form that you customized. If you added reference fields, the data in the referenced table is also sent as part of the SOAP response. This can lead to performance issues when credential synchronization occurs with multiple MID Servers. To control this, manually add these properties to the System Properties [sys_properties] table:

**Note:** To change the values in these properties, add them to the System Properties [sys_properties] table. If you do not add them, the system uses the default value.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.credentials_user_fields</td>
<td>Includes all customized fields in credential sync. Set this to false if you do not want to include the fields that you added to credential forms.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> true</td>
</tr>
<tr>
<td>com.snc.credentials_recursion_depth</td>
<td>Defines the number of tables to traverse when the credential sync mechanism collects fields from reference tables. Lower this number if you are experiencing performance issues and you have customized credential forms that include reference fields to tables that also have reference fields.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 3</td>
</tr>
</tbody>
</table>

**Domain separation for Credentials and Connections**

This is an overview of domain separation for Credentials and Connections. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Overview**

**Support: Level 1**

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

Credentials are tied to various ServiceNow features which access systems outside the instance. Credentials follow the domain separation tied to the feature employing the credentials.

Connections are protocol-specific information referencing a target host outside the instance. A connection can specify the domain to run an activity.

**How domain separation works in Credentials and Connections**

Credentials access resources outside of the instance, and are used by the #unique_558, Orchestration, #unique_560, and #unique_561 applications. These credentials are not tied to a specific domain, rather, they can be bound to an application and then follow the domain separation that the application uses.
Credentials can also be assigned to a MID Server, and then follow the domain separation specified by the MID Server configuration.

Connections access a target host using a JMS, JDBC, or HTTP(s) connection. You can specify global or a specific domain to which the connection belongs.

**Create connection attributes for IntegrationHub**

Define connection-specific variables that you can use in IntegrationHub integration steps.

- The admin role is required to create connection attributes.
- The connection_admin or admin role is required to assign attribute values.
- The action_designer or admin role is required to use attributes in a custom action.

Connection attributes are only used by integration steps, which require a subscription to IntegrationHub. For more information about activating IntegrationHub, see Request an IntegrationHub plugin.

When using an integration step, you must establish a connection with an external system. Use a Connection & Credential alias instead of defining the connection inline. An alias enables you to update the connection details once without having to reconfigure every action. Any action step that uses an alias inherits the attributes associated with it. Flow Designer displays attributes as data pills that you can drag into your action step. For example, you can create a page size attribute that becomes a REST step query parameter.

For more information about building custom Flow Designer actions, see Action Designer.

1. Navigate to **Credentials & Connections > Connection & Credential Aliases**.
2. Create or select an alias record.
3. From the Connection Attributes related list, click **New**. The Connection Attributes form opens.
4. Define the attribute label and field type. For a list of field types, see field types.
5. Click the Advanced view related link to set advanced dictionary preferences for the attribute. For example, to create an attribute with a dynamically calculated value. See Dictionary entry form.
6. Click **Submit**.
7. Define the attribute values in the connection record.
   a) Navigate to **Credentials & Connections > Connections**.
   b) Create or select a connection record with the same connection type as the alias.
   c) From **Connection alias**, select the alias with connection attributes.
   d) Save the record. The Attributes tab populates with the connection attributes defined in the alias record.
   e) Set values for the attributes.
      If the alias has **Support Multiple Active Connections** enabled, you can associate more than one connection record with an alias and define attribute values in each connection record. If there are multiple connection records with attribute values for the same alias, the connection used when the flow executes determines the attribute values. For example, suppose that you have one action that uses an alias with two active connections endpoints: production and test. The attribute resolves to the value defined by the connection used at runtime.
8. Add the alias to an integration step in Action Designer.
   a) Navigate to Flow Designer and create or select an action.
   b) Add an integration step to the action.
   c) Under Connection Details, add the alias you created attributes for.

   The connection attributes associated with the alias display as data pills in the Data pane.

   **Note:** The system does not track changes to connection attribute labels and data types after you associate the alias to a step. To refresh the connection attribute label or data type, delete the alias from the step and add it again.

### Setting up connections to target hosts

Use the connections table to set up a Basic, JMS, JDBC, or HTTP(s) connection.

### Connection Table

The Connection table (sys_connection) is the base table for all connection tables. You can set up connections for the following protocols:

- Basic connection for PowerShell and SSH
- JDBC
- JMS
- HTTP(s)

The connection table references the connection alias table, which couples the connection alias to connection information. Every connection records the following information:

#### Base connection properties

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the connection. This field must be unique on the table.</td>
</tr>
<tr>
<td>Credential</td>
<td>Specify the credential to use with this connection. This is optional.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>The connection alias resolves your connection and credentials at run time. Only one connection is active per Connection alias at any one time.</td>
</tr>
<tr>
<td>Active</td>
<td>Check to make the current connection active.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain to which the connection belongs.</td>
</tr>
</tbody>
</table>

Credential is unique across active connections, if not empty.

### Upgrading connection information

- The JDBC connection [jdbc_connection] and JMS connection [orch_jms_ds] tables are existing Orchestration connection tables that now extend from the Connection [sys_connection] table. The tables originally extended from sys_metadata. The sys_metadata related data is removed.

• The tables move from the Orchestration run time plugin [com.snc.runbook_automation.runtime] to the Credentials & Connections plugin.
• The upgrade process obtains JDBC and JMS connection information and creates corresponding connection aliases and assigns the alias to its corresponding connection.
• JDBC field name changes:
  • JDBC server is renamed to host
  • Database port is renamed to port
  • Data of the JDBC server and database migrates to host and port during the upgrade

Create a basic connection for PowerShell and SSH

Configure connection information to use with a custom activity or action that uses the PowerShell or Secure Shell (SSH) protocol.

Role required: admin or connection_admin

1. Navigate to Credentials & Connections > Connections.
2. Click New.
3. Select Basic Connection for PowerShell & SSH.
4. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the connection record.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the credential record used to authorize the connection.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Select the alias record to associate with this connection. Using an alias enables you to update the connection record without having to reconfigure any actions or activities that use the alias.</td>
</tr>
<tr>
<td>Host</td>
<td>Fully qualified domain name of the target host where the system runs the activity or action. For example, host.domain.com.</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>Select to connect to the target host through a MID Server. If selected, define fields in the Advanced MID Server Configuration section. Note: PowerShell requires a MID Server.</td>
</tr>
<tr>
<td>Active</td>
<td>Select to make this connection active.</td>
</tr>
<tr>
<td>Domain</td>
<td>Determines the domain the activity runs in. Flow Designer does not support domain separation and ignores this field.</td>
</tr>
<tr>
<td>Override default port</td>
<td>Target port used by the connection. If you leave this field blank, the system uses the default port value.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>The capabilities the MID Server must support to be eligible for selection. The system runs the action or activity from a MID Server that supports the selected capabilities. Only displays if Use MID server is selected. To learn more about how a MID Server is selected during runtime, see MID Server selection.</td>
</tr>
</tbody>
</table>
5. Click Submit.

Create an HTTP(s) connection

The HTTP(s) connection provides the information custom HTTP(s) actions or activities use to connect. Role required: connection_admin

1. Navigate to Credentials & Connections > Connections, click New, and select HTTP(s) Connection.
2. Add the following connection information and click Submit:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of this HTTP(s) connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the credential record used to authorize the connection.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Select the alias record to associate with this connection. Using an alias enables you to update the connection record without having to reconfigure any actions or activities that use the alias.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Either manually enter the connection URL or use system to build the URL based on the inputs. Default is unchecked. If checked, the connection URL is calculated from the following fields:</td>
</tr>
<tr>
<td></td>
<td>• Mutual authentication — Check box if mutual authentication is used.</td>
</tr>
<tr>
<td></td>
<td>• Protocol — If mutual authentication is not used, enter protocol. The default is HTTPS.</td>
</tr>
<tr>
<td></td>
<td>• Protocol profile — If mutual authentication is used, enter protocol profile from sys_protocol_profile.</td>
</tr>
<tr>
<td></td>
<td>• Host</td>
</tr>
<tr>
<td></td>
<td>• Port</td>
</tr>
<tr>
<td></td>
<td>• Base path — Path of the connection string.</td>
</tr>
</tbody>
</table>

Note: If mutual authentication is checked, connection URL is built: Protocol + :// + host:port + URL. If mutual authentication is unchecked, connection URL is built: Protocol profile + :// + host:port + URL.
### Option | Description
--- | ---
**Use MID server** | Check to use a MID Server for this action or activity. If selected, define fields in the Advanced MID Server Configuration section.

**Capabilities** | The capabilities the MID Server must support to be eligible for selection. The system runs the action or activity from a MID Server that supports the selected capabilities. Only displays if **Use MID server** is selected.

Required capabilities determine which MID Server is selected at runtime. To learn more about how a MID Server is selected during runtime, see **MID Server selection**.

**MID Application** | The application the MID Server must support to be eligible for selection. The system runs the action from a MID Server that supports the selected application. Only displays if **Use MID server** is selected.

To learn more about how a MID Server is selected during runtime, see **MID Server selection**.

3. Click **Submit**.

You are ready to create a custom HTTP(s) action or activity.

### Create a JDBC connection

The JDBC Connection provides the information custom JDBC actions or activities use to connect to various target databases.

You must have an appropriate JAR file, whether it is supplied with the instance or a custom JAR file.

**Note:** The ServiceNow instance supplies `mysql-connector-java-5.1.21.jar`, `sql-server-jdbc-4.0.jar`, and `ojdbc6.jar` files as part of the current release, which supports MySQL, SQLServer, and Oracle databases. Other databases, such as Sybase or DB2 Universal, must use a custom JAR file that must be uploaded to the instance before setting the JDBC connection.

Role required: connection_admin

JDBC credentials are retrieved separately by the activity designer template and support external credential storage, such as CyberArk.

1. Navigate to **Credentials & Connections > Connections**, click **New** and select **JDBC Connection**.
2. Complete the form using the fields in the table.

The database selection in the **Format** field determines which fields are available.

**JDBC connection fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Database Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>All</td>
<td>Unique name of this JDBC connection. For example, you might enter <strong>JDBC MySQLProd</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>All</td>
<td>Add credentials for JDBC provider.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Database Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection alias</td>
<td>All</td>
<td>Select the alias record to associate with this connection. Using an alias enables you to update the connection record without having to reconfigure any actions or activities that use the alias.</td>
</tr>
<tr>
<td>Query timeout</td>
<td>All</td>
<td>Maximum elapsed time the JDBC query is allowed to run without a response.</td>
</tr>
<tr>
<td>Connection timeout</td>
<td>All</td>
<td>Maximum elapsed time for the JDBC activity to wait while attempting to connect to the target database.</td>
</tr>
<tr>
<td>Active</td>
<td>All</td>
<td>Check the box to make this an active connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>All</td>
<td>Domain for this table. By default, the JDBC Connection [jdbc_connection] table runs in the global domain.</td>
</tr>
</tbody>
</table>
| Format                | All                      | Database type for this connection. The default choices are:  
  • MySQL  
  • Oracle  
  • SQLServer  
  • None  
  You can add Sybase or DB2 Universal to the choice list by uploading the appropriate JDBC driver JAR file to the instance. Orchestration automatically recognizes these drivers when they are loaded into the system and adds them to this list. |
<p>| Host                  | Oracle, MySQL, SQLServer| Host name or IP address of the database server.                                                                                                                                                             |
| Oracle sid            | Oracle                   | The Oracle database site identifier. The default value is orcl.                                                                                                                                              |
| Oracle port           | Oracle                   | Port that the Oracle database is using. The default value is 1521.                                                                                                                                          |
| Database name         | MySQL, SQLServer         | Name of the database.                                                                                                                                                                                         |
| Port                  | My SQL, SQLServer        | Port that the selected database is using.                                                                                                                                                                   |
| Instance name         | SQLServer                | Instance name for the selected SQLServer                                                                                                                                                                   |
| Connection URL        | All                      | URL that the MID Server uses to connect to the specified database. The URL is created automatically when you save the form, and is read-only for the default databases.                                          |
|                       |                          | <strong>Note:</strong> If the format selected is not one of the default databases, you must create the connection URL manually so that the MID Server knows how to create the connection.                                    |
| JDBC driver           | None, DB2 Universal, Sybase | The JDBC driver to use for this connection when it is not a default database.                                                                                                                                |
|                       |                          | <strong>Note:</strong> If you add a Sybase or DB2 Universal database, you must enter the driver name in this field and upload the driver JAR file to the instance.                                                           |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Database Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use MID server</td>
<td>All</td>
<td>Check to use a MID server for this action or activity. If selected, define fields in the Advanced MID Server Configuration section.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>All</td>
<td>The capabilities the MID Server must support to be eligible for selection. The system runs the action or activity from a MID Server that supports the selected capabilities. Only displays if Use MID server is selected. To learn more about how a MID Server is selected during runtime, see MID Server selection.</td>
</tr>
<tr>
<td>MID Application</td>
<td>All</td>
<td>The application the MID Server must support to be eligible for selection. The system runs the action from a MID Server that supports the selected application. Only displays if Use MID server is selected. To learn more about how a MID Server is selected during runtime, see MID Server selection.</td>
</tr>
</tbody>
</table>

3. Click Submit.

Create a JMS connection

Configure your system to use Java Messaging Service (JMS) with a custom JMS activity or action.

Role required: connection_admin

The MID Server must have the correct JMS connection factories for your organization. Configure those values in the mid.property.jms.command.allowed_factory_names property, found in MID Server > Properties. The default values for this property can be changed to any value or comma-separated list of values that the third-party JMS provider advertises.

1. Navigate to Credentials & Connections > Connections.
2. Click New, select JMS Connection, fill in the form, and then click Submit:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of this connection factory.</td>
</tr>
<tr>
<td>Credential</td>
<td>Add credentials for JMS provider.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Select the alias record to associate with this connection. Using an alias enables you to update the connection record without having to reconfigure any actions or activities that use the alias.</td>
</tr>
<tr>
<td>Initial Context Factory</td>
<td>Name of the JNDI class that is used to create the InitialContext. For example, to connect to ActiveMQ V5.10 (JMS Provider), the value is org.apache.activemq.jndi.ActiveMQInitialContextFactory.</td>
</tr>
<tr>
<td>Provider URL</td>
<td>Location of the running JMS provider installation. For example, to connect to ActiveMQ V5.1:tcp://ipAddressOrHostName:61616.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Check the box to make this an active connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Determine the domain the action or activity runs in.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Check to use a MID Server for this action or activity. If selected, define fields in the Advanced MID Server Configuration section.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>The capabilities the MID Server must support to be eligible for selection. The system runs the action or activity from a MID Server that supports the selected capabilities. Only displays if Use MID server is selected.</td>
</tr>
<tr>
<td></td>
<td>To learn more about how a MID Server is selected during runtime, see MID Server selection.</td>
</tr>
<tr>
<td>MID Application</td>
<td>The application the MID Server must support to be eligible for selection. The system runs the action from a MID Server that supports the selected application. Only displays if Use MID server is selected.</td>
</tr>
<tr>
<td></td>
<td>To learn more about how a MID Server is selected during runtime, see MID Server selection.</td>
</tr>
</tbody>
</table>


4. Click New, select JMS Credentials, and then provide the user name and password the MID should use to communicate with the JMS provider.
   For more information, see JMS credentials.

5. Click Submit.
   You are ready to create a custom JMS action or activity.

**Getting started with credentials**

The MID Server uses the credentials you create in the Credentials [discovery_credentials] table to access resources for Discovery, Orchestration, Service Mapping, and Cloud Management.

**How MID Servers use credentials**

By default, Windows MID Servers use the login credentials of the MID Server service on the host machine to discover Windows devices in the network. You should configure these service credentials so that they have at least local administrator privileges. For Linux and UNIX machines and network devices, the MID Server uses the SSH and SNMP credentials configured in the instance in Discovery > Credentials.

MID Servers that Orchestration uses must have access to the necessary credentials to execute commands on computers in the network as specified by the Workflow activities. Orchestration can use the same SSH and SNMP credentials as Discovery, but has two additional credentials designed for specific Workflow activities: Windows (for PowerShell) and VMware.

**Encryption and decryption**

The platform stores credentials in an encrypted field on the Credentials [discovery_credentials] table. Once they are entered, they cannot be viewed.
When credentials are requested by the MID Server, the platform decrypts the credentials using the following process:

1. The credentials are decrypted on the instance with the password2 fixed key.
2. The credentials are re-encrypted on the instance with the MID Server's public key.
3. The credentials are encrypted on the load balancer with SSL.
4. The credentials are decrypted on the MID Server with SSL.
5. The credentials are decrypted on the MID Server with the MID Server's private key.

Note: The platform does not have separate encryption keys for multi-tenant instances.

Credential order

Credentials can be assigned an order value in the Credentials Form, which forces the application to try all the credentials at their disposal in a certain sequence. If you do not specify an order value, the application tries the credentials in the Credentials [discovery_credential] table randomly, until it finds one that works, such as when Orchestration attempts to run a command on an SSH server (such as a Linux or UNIX machine), or when Discovery attempts to query an SNMP device (such as a printer, router, or UPS).

After identifying the credentials for a device, Discovery and Orchestration create an affinity between the credentials and the device using the Credential Affinity [dscy_credentials_affinity] table. All subsequent discoveries or Orchestration activities attempt to match the credentials in this table with a device for which an affinity exists. If credentials for a device change, Discovery and Orchestration try all available credentials again until they create a new affinity.

Note: If Orchestration and Discovery are installed, and credential alias is enabled, multiple affinities can exist. In this case, the platform looks up credentials for each affinity and inserts the credential for the affinity with the lowest order into the probe.

Ordering credentials is useful in the following situations:

- The credentials table contains many credentials, with some used more frequently than others. For example, if the table contains 150 SSH credentials, and 5 of those are used to log into 90% of the devices, it is good practice to configure those five with low order numbers, which places them at the top of the execution list. Discovery and Orchestration will work faster if they try these common credentials first. After the first successful connection, the system knows which credentials to use the next time for each device.
- The system has aggressive login security. For example, if the Solaris database servers in the network only allow three failed login attempts before they lock out the MID Server, configure the database credentials with a low order value.

Credential aliases

Credential aliases are available for Discovery and Orchestration.

Aliases for Discovery allow an administrator to:

- Employ a credential filtering behavior with configurable levels of compliance.
- Assign multiple credential aliases to a Discovery schedule.
- Prevent the creation of credential affinities that use inappropriate or sensitive credentials.
Aliases for Orchestration allow workflow creators to:

- Assign individual credentials to any activity in an Orchestration workflow
- Assign individual credentials to any action in Flow Designer
- Assign different credentials to each occurrence of the same activity type in an Orchestration workflow.
- Assign different credentials to each occurrence of the same action in designer flow.

External credential stores

If you do not want credentials stored in your instance, you can use external credential repositories. External credential stores save the credentials in an external site that your instance can access. CyberArk is the only supported external credential store, but other external storage solutions can be configured using the ServiceNow API.

Create a Connection & Credential alias

Define an alias to label a credential or connection record.

- The admin role is required to create an alias.
- The credential_admin and connection_admin roles have read access to the alias record.

The Connection & Credential alias defines an alias that labels a credential or connection record. The alias contains these fields.

1. Navigate to Credentials & Connections > Connection & Credential Aliases.
2. Click New.
3. Complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the alias. Can only contain alpha, number, and underscore characters. During an upgrade, the tag in the credential record migrates to a Connection &amp; Credential Alias. If the credential tag contains special characters other than alphabets, numbers, and underscores, the tag name is preserved after the upgrade. You can still use this migrated alias, but you cannot update the alias until you change the name to meet the naming restrictions.</td>
</tr>
<tr>
<td>ID</td>
<td>This field is based on the format scope_name.alias_name. The ID must be unique. If the scope is global, the ID is the alias name. For example, if you create a workday alias in global scope, the ID is set to workday. If you create a workday alias in the HR app scope, the ID is set to x_hr_app.workday.</td>
</tr>
<tr>
<td>Type</td>
<td>Select either Credential or Connection and Credential. The default is Connection and Credential.</td>
</tr>
<tr>
<td>Connection type</td>
<td>Select a connection type: Basic, HTTP, JDBC, JMS. The default is HTTP.</td>
</tr>
<tr>
<td>Support Multiple Active Connections</td>
<td>Define whether the alias supports multiple active connections. Add connections using the Connections table and associated them to the alias using the Connections related list.</td>
</tr>
<tr>
<td>Default Retry Policy</td>
<td>Select a retry policy. For more information, see Retry policy.</td>
</tr>
</tbody>
</table>
4. Click **Save**.
The Connections and Connection Attributes related lists display.

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Related connection records associated with this alias. After creating the alias, you can define connection records and associate them with the alias. If <strong>Support Multiple Active Connections</strong> is selected, you can associate more than one connection with an alias.</td>
</tr>
<tr>
<td>Connection Attributes</td>
<td>Define data specific to a connection and use it in an IntegrationHub integration step. For more information, see Create connection attributes for IntegrationHub.</td>
</tr>
</tbody>
</table>

Create one or more connection records to associate with the alias. For more information about creating connections, see Setting up connections to target hosts. Add connection attributes to the alias to make connection meta data available to flows in Flow Designer.

**Credential aliases for Discovery**

Credential aliases for Discovery allow an administrator to use specific credentials on Discovery schedules. You can configure behaviors for your aliases that determine how strictly the system enforces their use.

Without credential aliases, Discovery schedules can access all credentials that are defined in the instance. This behavior might not be desirable in some circumstances, particularly for credentials with elevated privileges. Credential aliases provide more control over which credentials a Discovery schedule is allowed to use and prevents the unnecessary exposure of credentials with elevated privileges.

**Note:** Credential alias is not currently supported for pattern engine.

**How credential aliases work**

A business rule called Insert Discovery Affinity & Cred Aliases (previously named Insert Discovery Affinity) runs when a record is inserted into the ECC Queue. The business rule attaches the credential aliases defined in the Discovery schedule to the probe, so that the MID Server can perform credential filtering. The MID Server's first task is to create the list of credentials to search. It filters the credentials by affinity and then by tags, if any exist. The affinities go to the top of the list, and the matching tags go to the bottom of the list. The MID Server iterates through the list until it finds a credential that works. The MID Server then creates an affinity for this credential.

If the business rule determines that an affinity exists for the device, the rule identifies the proper credential_id to use. This is the sys_id of the record in the Credentials [discovery_credentials] table. When the platform encounters an affinity with a credential alias value, defined as credential_alias in the business rule, the business rule determines whether or not the credential referenced by the affinity has the specified alias. If it does, the business rule selects the credential_id of the alias and passes that value to the MID Server. If the credential does not have the specified credential alias, any other affinities that exist for the target system are checked.

**Create a Discovery credential alias**

Create the alias and then add that alias to a credential in the credential record. You can add a credential to multiple aliases and add multiple credentials to a single alias.

Role required: admin, credential_admin (read access only), connection_admin (read access only)

A Discovery schedule only uses credentials that are contained in the aliases defined for that schedule.

1. Create an alias.
a) Navigate to Connections & Credentials > Connection & Credential Aliases.
b) Click New.
c) Enter a unique name for the alias and select Credential for the alias Type.
d) Click Submit.

The Credentials related list appears. You can add new credentials for this alias in this list but not existing credentials.
2. Configure a credential for the new alias.
   a) Navigate to **Connections & Credentials > Credentials**.
   b) Select an existing credential from the list or click **New** to create a new credential.
   c) In the credential record, unlock the **Credential alias** field and select the alias you created.
   d) Save or submit the record.
3. Return to Connections & Credentials > Connection & Credential Aliases and open your new alias. The credential you attached to the alias now appears in the related list.

4. To create an additional credential for this alias, click New in the related list and select a credential type. The alias name is pre-populated in the Credential alias field of the credential record.

5. Complete the fields in the form and submit the record.

Create and test your credentials

Create and test the credentials that Discovery, Service Mapping, Cloud Management, and Orchestration require to access hardware and software in your network.

Role required: admin

This task contains general procedures for creating credentials. Refer to the documentation for your credential type for details on specific fields and requirements.

<table>
<thead>
<tr>
<th>Supported credential types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicative credentials</td>
</tr>
<tr>
<td>Basic authentication credentials</td>
</tr>
<tr>
<td>Chef server credentials</td>
</tr>
</tbody>
</table>
1. Navigate to one of these modules:
   - Discovery > Credentials
   - Service Mapping > Credentials
   - Orchestration > Credentials

2. Click New.

3. On the Credentials page, click a link for the credential type and complete the form. Refer to the documentation for the credential type you selected for details.
   
   You can submit a credential record first and then test it later, or test the credential immediately before saving it.
   
   Credential testing is supported for these credential types:
   - SSH (including private keys)
   - Windows
   - SNMP (including v3)
   - VMware
   - JDBC
   - JMS

4. Under Related Links, click Test credential.

   Note: Credentials are encrypted at all times during the test.
5. Complete the fields in the Test Credential dialog box.

![Test Credential dialog box](image)

**Test credentials dialog box**

**Credential test fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Credential type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>Target host on which these credentials are run. This value must be an IP address for all credential types except VMware, which can be the host URL. You can not target any MID servers. Note: For JMS, this is the provider URL. The information in this URL tells JNDI how to find and access the JMS Provider. An example value for connecting to ActiveMQ V5.1, is <code>tcp://ipAddressOrHostName:61616</code>.</td>
<td>All</td>
</tr>
<tr>
<td>Port</td>
<td>Port on the target to use for this test. The system pre-populates this field with the default port for the selected credential type.</td>
<td>All</td>
</tr>
<tr>
<td>MID Server</td>
<td>MID Server to use for this test. You must use a Windows MID Server to test Windows credentials. Only Up and Validated MID Servers are available.</td>
<td>All</td>
</tr>
<tr>
<td>DB Type</td>
<td>Type of database on which to test these credentials.</td>
<td>JDBC</td>
</tr>
<tr>
<td>DB Name</td>
<td>Name of the database on which to test these credentials.</td>
<td>JDBC</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Credential type</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Initial Context Factory</td>
<td>Name of the JNDI class that is used to create the InitialContext. Using this Initial Context Factory, various JMS objects, such as JMS Connection, are created. For example, to connect to ActiveMQ V5.10, (JMS Provider), the value in this field would be org.apache.activemq.jndi.ActiveMQInitialContextFactory</td>
<td>JMS</td>
</tr>
</tbody>
</table>

6. Click **OK** to begin the test.

An indicator appears, showing that the system is attempting to contact the target using the credentials you have provided. When the instance connects to the target it displays a success message. If the instance encounters a problem with the test inputs you have provided, it displays the appropriate error message. The following are some common error messages.

- Incorrect target or port number:

  ![TCP connection failure](image)

  **TCP connection failure**

- Incorrect user name or password:

  ![Authentication failure](image)

  **Authentication failure**

- Incorrect MID Server for Windows credentials:

  ![MID Server error](image)

  **MID Server error**

7. Click **Retry** to open the test Credential dialog box and correct the input error.
8. When your credentials test is successful, click **Submit** to save the record.

**Important:** Testing credentials does not ensure that the credentials have the necessary privileges required for the intended Discovery or Orchestration workflow tasks.

### Ansible Tower credentials

Ansible Tower credentials are required to access your Ansible configuration management account. Use these credentials to manage Ansible resources through the Cloud Management application.

To integrate Cloud Management with the Ansible configuration management account, you need only to configure the user name and password for the administrator account in Ansible.

**Form fields for Ansible Tower credentials**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a descriptive name.</td>
</tr>
<tr>
<td>User name/Password</td>
<td>Enter the authentication credentials for the Ansible Tower user with administrator rights.</td>
</tr>
</tbody>
</table>

**Note:** You do not need to configure the other fields.

### API key credentials

An API key is a unique code that is passed in to an API to identify the calling application or user.

### API key credentials

**API key credentials form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>API Key</td>
<td>Enter the API key.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow flow and workflow creators to assign individual credentials to any activity in a flow or workflow or assign different credentials to each occurrence of the same activity type in a flow or workflow.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field.</td>
</tr>
</tbody>
</table>
Field	Input value
Order	Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.

Applicative credentials

Some applications require credentials in addition to the credentials that the host machine requires. Credentials required to access these applications are referred to as applicative credentials.

A typical credential contains a user name and a password for logging into a device or application. While most applications require only one credential for accessing them, sometimes hosts and applications have separate credentials for extra security. For example, ABAP SAP Central Services (ASCS) requires applicative credentials in addition to the SSH or Windows host credentials for the server that hosts ASCS.

Note: ServiceNow applications refer to devices and applications that comprise an application service as configuration items (CIs).

Just like with host credentials, you assign applicative credentials to MID Servers.

You create applicative credentials per CI type, for example the CI type for ASCS is SAP ASCS Application [cmdb_ci_appl_sap_ascs]. The preconfigured pattern for discovering CIs belonging to this CI type contains commands that require a MID Server to use the applicative credential for this CI type. If there is more than one credential configured for this CI type, the MID Server tries using these credentials in the order you define until it finds the credential that fits.

Check the discovery requirements information in the ServiceNow documentation to determine if you need to configure applicative credentials for specific application CIs. There is no need to configure applicative credentials, if discovery prerequisites do not mention it.

Applicative credentials form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the credential. Use a descriptive name like Oracle DB or London Oracle DB (for an Oracle database). Do not use spaces or special characters for the credential name.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to use the credential.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the actual user name of the applicative credential.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the actual password of the applicative credential. Do not use spaces or special characters for the credential name.</td>
</tr>
<tr>
<td>CI type</td>
<td>Select a CI type to which the CI belongs.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Create an alias to assign specific credentials for specific discovery schedules. When assigning an alias, you must identify the table name for the CI type whose applicative credentials the application uses. Applications may use applicative credentials of a CI type different from their own. For a specific application, see the list for the appropriate table:</td>
</tr>
<tr>
<td></td>
<td>• ABAP SAP Central Services (ASCS): cmdb_ci_appl_sap_ascs</td>
</tr>
<tr>
<td></td>
<td>• IBM Security Access Manager appliance: cmdb_ci_app_server_webseal</td>
</tr>
<tr>
<td></td>
<td>• SAP Central Instance: cmdb_ci_appl_sap_ascs</td>
</tr>
<tr>
<td></td>
<td>• SAP Central Services (SCS): cmdb_ci_appl_sap_ascs</td>
</tr>
<tr>
<td></td>
<td>• SAP Evaluated Receipt Settlement (ERS): cmdb_ci_appl_sap_ascs</td>
</tr>
<tr>
<td></td>
<td>• SAP Java Cluster: cmdb_ci_appl_sap_ascs</td>
</tr>
<tr>
<td></td>
<td>• SAP NetWeaver Dialog Instance: cmdb_ci_appl_sap_ascs</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Exchange Mailbox (for Microsoft Exchange): cmdb_ci_exchange_mailbox</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Database: cmdb_ci_db_mssql_instance</td>
</tr>
<tr>
<td></td>
<td>• MySQL Server: cmdb_ci_db_mysql_instance</td>
</tr>
<tr>
<td></td>
<td>• Oracle Advanced Queue Queue: cmdb_ci_db_ora_instance</td>
</tr>
<tr>
<td></td>
<td>• Oracle Database: cmdb_ci_db_ora_instance</td>
</tr>
<tr>
<td></td>
<td>• Oracle E-Business Suite: cmdb_ci_db_ora_instance</td>
</tr>
<tr>
<td></td>
<td>• Oracle WebLogic Module: cmdb_ci_app_server_weblogic</td>
</tr>
<tr>
<td></td>
<td>• Tibco Enterprise Message Service (EMS): cmdb_ci_app_server_weblogic</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
</tbody>
</table>

### Basic authentication credentials

The basic authentication credential type manages access to store basic authentication credentials. These fields are available in the Credentials form for basic authentication.

**Basic Auth credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential. For example, you might call it Basic Authentication.</td>
</tr>
<tr>
<td>User Name</td>
<td>Enter the user name.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
</tbody>
</table>
### Field | Input value
--- | ---
Credential ID | Enter the unique key configured for these credentials in the CyberArk external credential storage system.

The credential ID may be used as a safe override when multiple safes are in use. By default, the syntax in the Credential ID field is this: `<safe name>:<Credential ID>`. If the safe name is omitted, there must be a safe name defined in the `config.xml` file. To change the separator character from the default colon to another character, override the value with the optional `ext.cred.safe_name` parameter. The Credential ID field has a limit of 40 characters.

This field is only visible when the External storage check box is selected.

External credential store | Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. Currently, the only supported external storage system is CyberArk.

Order | Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.

---

### Chef server credentials

Chef server credentials access chef integrations with the instance.

These fields are available on the Credentials form for Chef server type credentials. This information comes from the settings you configured when you performed Chef server installation.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>Admin Name</td>
<td>Provide the administrator name that you created during Chef server installation.</td>
</tr>
<tr>
<td>Admin Key</td>
<td>Enter the RSA private key that the Chef server generated when you created the administrator.</td>
</tr>
<tr>
<td>Validator Name</td>
<td>Enter the validator.</td>
</tr>
<tr>
<td>Validator Key</td>
<td>Enter the RSA private key that the Chef server generated when you created an organization.</td>
</tr>
<tr>
<td>Cert Name</td>
<td>Enter the certification name.</td>
</tr>
</tbody>
</table>
### CIM credentials

The CIM credential type manages access to a CIM server (also referred to as a CIMOM - Common Information Model Object Manager) for information about VMware ESX servers. This credential type is available for Discovery.

These fields are available in the Credentials form for CIM.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table.</td>
</tr>
<tr>
<td></td>
<td>Avoid leading or trailing spaces in user names. A warning appears if the</td>
</tr>
<tr>
<td></td>
<td>platform detects leading or trailing spaces in the user name. For CIM</td>
</tr>
<tr>
<td></td>
<td>discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file</td>
</tr>
<tr>
<td></td>
<td>uploaded to the MID Server for an external credential system. The Credential</td>
</tr>
<tr>
<td></td>
<td>ID field has a limit of 40 characters.</td>
</tr>
<tr>
<td></td>
<td>This field is only visible when the External credential store check box</td>
</tr>
<tr>
<td></td>
<td>is selected.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow workflow creators to assign individual credentials to any activity in</td>
</tr>
<tr>
<td></td>
<td>an Orchestration workflow or assign different credentials to each occurrence</td>
</tr>
<tr>
<td></td>
<td>of the same activity type in an Orchestration workflow.</td>
</tr>
<tr>
<td></td>
<td>To use the credential for discovering CIs not belonging to this CI type</td>
</tr>
<tr>
<td></td>
<td>using Service Mapping and Discovery patterns, enter the table name for the</td>
</tr>
<tr>
<td></td>
<td>CI type to which the CI belongs, for example cmdb_ci_apache_web_server.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Change credentials to non-default.</td>
</tr>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. External credential storage is only available when the External Credential Storage plugin in activated.</td>
</tr>
</tbody>
</table>

**Note:** Currently, the only supported external storage system is CyberArk.
### Configure NetApp storage devices for CIM credentials

NetApp storage devices require additional configuration in order for Discovery to explore them.

**Role required:** admin

1. Install the SMI-S agent on the storage device host. See the Data ONTAP SMI-S Agent 5.2 Installation and Configuration Guide for instructions and requirements.

   **Note:**
   ServiceNow does not maintain the documentation on this site. Be aware that this document can change without notice.

2. Create a user account and password for the SMI-S agent.
3. Create a credential record for the SMI-S agent credentials. Set the credential type to **CIM**.

### Cloud credentials

Cloud credential types manage access to cloud-based applications, including Amazon Web Services and the Microsoft Azure cloud.

### AWS Identity and Access Management (IAM) roles

If you have a MID Server installed on Amazon EC2 in an AWS cloud, and if that MID Server is configured to discover resources within the cloud, you can use security credentials provided by AWS Identity and Access Management (IAM) roles rather than credentials managed on your instance. These AWS credentials grant permissions in the cloud through an instance profile, based on roles. These credentials are temporary and rotate automatically on a configurable interval. When an IAM role is defined for the MID Server, Discovery ignores any credentials stored on the instance in favor of the credentials granted by the role in the instance profile. For more information on AWS instance profiles, see IAM Roles for Amazon EC2.
AWS credentials

AWS Credentials form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for the AWS credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to use the credential.</td>
</tr>
<tr>
<td>Access Key ID</td>
<td>Enter the <strong>Access key ID</strong> that you generated on the AWS Management Console, such as: APIAIOSFODNN7EXAMPLE.</td>
</tr>
<tr>
<td>Secret Access Key</td>
<td>Enter the <strong>Secret access key</strong> that you generated on the AWS Management Console, such as: wPairXUtEnFEMi/K7MDENG/bPxRfIvEXAMPLEKEY.</td>
</tr>
</tbody>
</table>

Azure Service Principal credential form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the service principal to register with the instance.</td>
</tr>
<tr>
<td>Tenant ID and</td>
<td>Paste the Azure <strong>Directory ID</strong> value from the Azure portal into the Cloud Management <strong>Tenant ID</strong> field.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Paste the Azure <strong>Application ID</strong> value of the application that you registered in Azure into the Cloud Management <strong>Client ID</strong> field.</td>
</tr>
<tr>
<td>Authentication Method</td>
<td>Select <strong>Client secret</strong>.</td>
</tr>
<tr>
<td>Secret key</td>
<td>Paste the secret key that was generated while creating the Azure Service Principal. This field appears when <strong>Authentication method</strong> is <strong>Client secret</strong>.</td>
</tr>
</tbody>
</table>

Note: **Client assertion** is not supported.

Azure Enterprise Agreement credentials

Azure Enterprise Agreement credentials are necessary for the billing functionality that the Cloud Management application provides.

Azure Enterprise Agreement credentials form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Enrollment number</td>
<td>Enter the enrolment number from Azure.</td>
</tr>
<tr>
<td>Access Key</td>
<td>Paste the access key that Azure provides.</td>
</tr>
</tbody>
</table>

**Cloud Management credentials**

This credential type is available for Orchestration.

**Cloud Management credentials form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential. For example, you might call it <strong>Cloud Atlanta</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>Type</td>
<td>Specify <strong>AWS</strong>.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the CIM user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the CIM password.</td>
</tr>
<tr>
<td>SSH Passphrase</td>
<td>Enter a memorable phrase for key generation. For example, you might enter <strong>Friday is a good day</strong>.</td>
</tr>
<tr>
<td>SSH private key</td>
<td>Enter the SSH private key.</td>
</tr>
<tr>
<td>Authentication protocol</td>
<td>Select the <strong>MD5</strong> or <strong>SHA</strong> authentication protocol that was used to generate the <strong>Authentication Key</strong>.</td>
</tr>
<tr>
<td>Authentication Key</td>
<td>Enter a SSH-generated authentication key.</td>
</tr>
<tr>
<td>Privacy protocol</td>
<td>Enter one of the following privacy protocols that describes encryption for the <strong>Privacy Key</strong>:</td>
</tr>
<tr>
<td></td>
<td>• <strong>3DES</strong> for Triple Data Encryption Standard (DES)</td>
</tr>
<tr>
<td></td>
<td>• <strong>AES128</strong> for Advanced Encryption Standard (AES) with 128 bit encryption</td>
</tr>
<tr>
<td></td>
<td>• <strong>AES192</strong> for AES with 192 bit encryption</td>
</tr>
<tr>
<td></td>
<td>• <strong>AES256</strong> for AES with 256 bit encryption</td>
</tr>
<tr>
<td></td>
<td>• <strong>DES</strong> for legacy DES encryption</td>
</tr>
<tr>
<td></td>
<td>Enter an additional privacy key.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When you select this option the <strong>User name</strong> and <strong>Password</strong> fields are replaced with the <strong>Credential ID</strong> field. Currently, the only supported external storage system is CyberArk.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to <strong>All MID servers</strong> in your network, or to one or more <strong>Specific MID servers</strong>. Specify the MID Servers that should use these credentials in the <strong>MID servers</strong> field.</td>
</tr>
<tr>
<td>Classification</td>
<td>Enter the Application Classification for CI discovery.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
</tbody>
</table>

### Cloud Management (CMP) node credentials

Cloud Management (CMP) node credentials associate credentials for a virtual server that Cloud Management provisions. The Cloud Management application automatically creates these credentials.

**Note:** You might need to deactivate these credentials if you no longer want them used, change the order precedence, or select a MID Server that is allowed to access them. Otherwise, you do not need to manually create or modify this type of credential.

### CMP node credentials form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The automatically generated name based on the datacenter where the virtual machine is located.</td>
</tr>
<tr>
<td>Active</td>
<td>If the credentials are active.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Choose whether this credential is available to a specific MID Server or a all MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>User Name and Password</td>
<td>The virtual server user name and password.</td>
</tr>
<tr>
<td>SSH passphrase and SSH private key</td>
<td>The private key and the passphrase that protects the key if the virtual server requires it.</td>
</tr>
<tr>
<td>Authentication Protocol and Authentication Key</td>
<td>The private key and the passphrase that protects the key if the virtual server requires it.</td>
</tr>
<tr>
<td>Privacy Protocol and Privacy Key</td>
<td>The encryption protocol used with the virtual server and enter the privacy key.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.</td>
</tr>
</tbody>
</table>

### Cloud Management (CMP) SSH key pair credentials

Cloud Management (CMP) SSH key pairs store the keys that the Cloud Management application automatically generates when users provision stack resources.

**Note:** You might need to deactivate these credentials if you no longer want them used. Otherwise, you do not need to manually create or modify this type of credential.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The automatically generated name.</td>
</tr>
<tr>
<td>Active</td>
<td>If the credentials are active.</td>
</tr>
<tr>
<td>SSH Public Key</td>
<td>The public key.</td>
</tr>
<tr>
<td>SSH Private Key</td>
<td>A secure private key that can be used instead of a password for SSH logins.</td>
</tr>
</tbody>
</table>

### Infoblox credentials

Infoblox credentials are required to set up IP pools (IPAM) in the Cloud Management application. These fields are available on the Credentials form for Infoblox type credentials.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Choose whether this credential is available to a specific MID Server or a all MID Servers.</td>
</tr>
</tbody>
</table>
ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
<tr>
<td>wAPI Version</td>
<td>Enter the version of wAPI you are using.</td>
</tr>
<tr>
<td>User Name and Password</td>
<td>Enter the InfoBlox user name and password.</td>
</tr>
</tbody>
</table>

**JDBC credentials**

The JDBC credential type manages access to a Java Database Connectivity (JDBC) connection. This credential type is available for Discovery and Orchestration.

These fields are available in the Credentials form for JDBC type credentials.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. For CIM discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The <strong>Credential ID</strong> field has a limit of 40 characters. This field is only visible when the <strong>External credential store</strong> check box is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow. To use the credential for discovering CIs not belonging to this CI type using Service Mapping and Discovery patterns, enter the table name for the CI type to which the CI belongs, for example cmdb_ci_apache_web_server. For more information, see Change credentials to non-default.</td>
</tr>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. External credential storage is only available when the External Credential Storage plugin is activated. Note: Currently, the only supported external storage system is CyberArk.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field.</td>
</tr>
<tr>
<td>MID servers</td>
<td>Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select Specific MID servers from the Applies to field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
</tbody>
</table>

### JMS credentials

The JMS credentials type manages access to a Java Message Service (JMS). This credential type is available for Discovery and Orchestration.

These fields are available in the Credentials form for JMS.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. For CIM discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The Credential ID field has a limit of 40 characters. This field is only visible when the External credential store check box is selected.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow. To use the credential for discovering CIs not belonging to this CI type using Service Mapping and Discovery patterns, enter the table name for the CI type to which the CI belongs, for example cmdb_ci_apache_web_server. For more information, see Change credentials to non-default.</td>
</tr>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. External credential storage is only available when the External Credential Storage plugin in activated. Note: Currently, the only supported external storage system is CyberArk.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field.</td>
</tr>
<tr>
<td>MID servers</td>
<td>Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select Specific MID servers from the Applies to field.</td>
</tr>
</tbody>
</table>
OAuth 2.0 credentials

OAuth 2.0 credentials enable ServiceNow to obtain access to user accounts on an HTTP service. These fields are available in the Credentials form for OAuth 2.0.

OAuth 2.0 credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential. For example, you might call it <strong>OAuth2 credential</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Specify whether this credential is active.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>An OAuth profile is a combination of a grant type and at least one scope.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Specify whether the credential is for all MID Servers, or specific MID servers. If specific, add the MID servers as necessary.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Specify the credential alias you want to tie to the OAuth 2.0 credential.</td>
</tr>
</tbody>
</table>

SAP credentials

The SAP credential type manages access to SAP JCo systems. This credential type is available for Discovery and Orchestration.

These fields are available in the Credentials form for SAP type credentials.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. For CIM discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The Credential ID field has a limit of 40 characters. This field is only visible when the External credential store check box is selected.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow. To use the credential for discovering CIs not belonging to this CI type using Service Mapping and Discovery patterns, enter the table name for the CI type to which the CI belongs, for example cmdb_ci_apache_web_server. For more information, see Change credentials to non-default.</td>
</tr>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. External credential storage is only available when the External Credential Storage plugin in activated. Note: Currently, the only supported external storage system is CyberArk.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field.</td>
</tr>
<tr>
<td>MID servers</td>
<td>Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select Specific MID servers from the Applies to field.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
</tbody>
</table>

### SNMP credentials

Discovery explores many kinds of devices (switches, routers, printers, etc.) using the SNMP protocol. Credentials for SNMP do not include a user name, just a password, called the community string.

The default read-only community string for many SNMP devices is public, and Discovery will try that automatically. Enter the appropriate SNMP credentials if they differ from the public community string.

Discovering SNMP uses all community strings that are configured. This behavior does not apply to discovering SNMPv3.

The default Orchestration activity SNMP Query returns the object identifier (OID) of a device and requires SNMP credentials.

**SNMP community credentials**

The SNMP Community credential type manages access to discover many kinds of devices (switches, routers, printers, etc.) using the SNMP protocol. This credential type is available for Discovery, Service Mapping, and Orchestration.

Credentials for SNMP do not include a user name, just a password (the community string). The default read-only community string for many SNMP devices is public, and the system will try that automatically. Enter the appropriate SNMP credentials if they differ from the public community string.

These fields are available in the Credentials form for SNMP community.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. For CIM discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The Credential ID field has a limit of 40 characters. This field is only visible when the External credential store check box is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Credential alias              | Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.  
To use the credential for discovering CIs not belonging to this CI type using Service Mapping and Discovery patterns, enter the table name for the CI type to which the CI belongs, for example cmdb_ci_apache_web_server. For more information, see Change credentials to non-default. |
| External credential store     | Select this check box to use an external credential storage system. When you select this option the **User name** and **Password** fields are replaced with the **Credential ID** field. External credential storage is only available when the External Credential Storage plugin in activated.  
**Note:** Currently, the only supported external storage system is CyberArk. |
| Applies to                    | Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the **MID servers** field.                                           |
| MID servers                   | Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select Specific MID servers from the Applies to field.                                        |
| Order                         | Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order. |

**SNMPv3 credentials**  
SNMP credentials accept a privacy protocol and an additional privacy key and are available for Discovery and Orchestration.  
Discovering SNMP uses all community strings that are configured. This behavior does not apply to discovering SNMPv3. These fields are available in the Credentials form for SNMPv3.
### SNMP v3 form

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and descriptive name for this credential. For example, you might call it <strong>SNMP Community Atlanta</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to <strong>All MID servers</strong> in your network, or to one or more <strong>Specific MID servers</strong>. Specify the MID Servers that should use these credentials in the <strong>MID servers</strong> field.</td>
</tr>
<tr>
<td>MID servers</td>
<td>Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select <strong>Specific MID servers</strong> from the <strong>Applies to</strong> field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the SNMP user name. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name.</td>
</tr>
<tr>
<td>Authentication protocol</td>
<td>Select the authentication type to use for this credential. The choices are <strong>MD5</strong> and <strong>SHA</strong>.</td>
</tr>
<tr>
<td>Authentication Key</td>
<td>Enter the authentication key to use for this credential.</td>
</tr>
<tr>
<td>Privacy protocol</td>
<td>Select the encryption protocol for this credential. The choices are:</td>
</tr>
<tr>
<td></td>
<td>• 3DES</td>
</tr>
<tr>
<td></td>
<td>• AES128</td>
</tr>
<tr>
<td></td>
<td>• AES192</td>
</tr>
<tr>
<td></td>
<td>• AES256</td>
</tr>
<tr>
<td></td>
<td>• DES</td>
</tr>
<tr>
<td>Privacy key</td>
<td>Enter the key associated with the selected privacy protocol.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The <strong>Credential ID</strong> field has a limit of 40 characters. This field is only visible when the <strong>External credential store</strong> check box is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Input value</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.</td>
</tr>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When you select this option the <strong>User name</strong> and <strong>Password</strong> fields are replaced with the <strong>Credential ID</strong> field. External credential storage is only available when the <strong>External Credential Storage plugin</strong> is activated.</td>
</tr>
</tbody>
</table>

**SSH credentials**

Discovery, Orchestration, and IntegrationHub explore UNIX and Linux devices by using SSH credentials to execute commands over Secure Shell (SSH). SSH commands must run with root privileges, either with root credentials or through the use of sudo.

**Privileged commands**

The platform provides default privileged commands for the MID Server to use and the ability to add additional commands to the system. For details about using sudo and other privileged commands, see **MID Server privileged commands**.

**Commands that require root privileges for Discovery, Orchestration, and IntegrationHub**

These examples assume that the user name is **Disco**. Substitute the actual user name and ensure that the paths for the commands match the paths on the system.

**Note:** Sudo commands do not work with private key credentials, because there is no password to supply to the sudo command. A solution is to add the **NOPASSWD** option to the sudo configuration. For example, you might enter:  
```
disco ALL=(root) NOPASSWD: /usr/bin/adb, /usr/sbin/lsof, /sbin/ifconfig
```

**UNIX and Linux commands requiring root privileges**

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HP-UX</strong></td>
<td></td>
</tr>
</tbody>
</table>
| adb     | Gathers CPU speed and memory.  
• /etc/sudoers line example: Disco ALL=(root) /usr/bin/adb  
• Used by: Discovery |
| **All Linux and UNIX versions** | |
| chage   | Changes the number of days between password changes and the date of the last password change.  
• /etc/sudoers line example: Disco ALL=(root) /usr/bin/chage  
• Used by: Orchestration and IntegrationHub |
<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>chpasswd</td>
<td>Changes user passwords.</td>
</tr>
<tr>
<td></td>
<td>• /etc/sudoers line example: Disco ALL=(root) /etc/chpasswd</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Orchestration and IntegrationHub</td>
</tr>
<tr>
<td>All Linux</td>
<td></td>
</tr>
<tr>
<td>dmidecode</td>
<td>Gathers several pieces of information about the hardware, including the serial number</td>
</tr>
<tr>
<td></td>
<td>number embedded within the motherboard.</td>
</tr>
<tr>
<td></td>
<td>• /etc/sudoers line example: Disco ALL=(root) /sbin/dmidecode</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Discovery</td>
</tr>
<tr>
<td>fdisk</td>
<td>Gathers the disks and size information on the system.</td>
</tr>
<tr>
<td></td>
<td>• /etc/sudoers line example: Disco ALL=(root) /usr/bin/fdisk -l</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Discovery</td>
</tr>
<tr>
<td>multipath</td>
<td>Gathers device mappings for MPIO.</td>
</tr>
<tr>
<td></td>
<td>• /etc/sudoers line example: Disco ALL=(root) /usr/bin/multipath -Il</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Discovery</td>
</tr>
<tr>
<td>Linux and Solaris</td>
<td></td>
</tr>
<tr>
<td>dmsetup</td>
<td>Examines a low level volume.</td>
</tr>
<tr>
<td></td>
<td>• /etc/sudoers line example:</td>
</tr>
<tr>
<td></td>
<td>• Disco ALL=(root) /usr/bin/dmsetup table *</td>
</tr>
<tr>
<td></td>
<td>• Disco ALL=(root) /usr/bin/dmsetup ls</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Discovery</td>
</tr>
<tr>
<td>All UNIX versions</td>
<td></td>
</tr>
<tr>
<td>lsof</td>
<td>Determines the relationship between processes and the connections being made to the system.</td>
</tr>
<tr>
<td></td>
<td>• /etc/sudoers line example: Disco ALL=(root) /sbin/lsof</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Discovery</td>
</tr>
<tr>
<td>oratab</td>
<td>Grants read access to the oratab file for locating the Oracle Home and pfile.</td>
</tr>
<tr>
<td></td>
<td>• /etc/sudoers line example: N/A</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Discovery</td>
</tr>
<tr>
<td>Solaris</td>
<td></td>
</tr>
<tr>
<td>iscsiadm</td>
<td>Gets iSCSI IQNs</td>
</tr>
<tr>
<td></td>
<td>• /etc/sudoers line example: ${sudo:iscsiadm list target -S}</td>
</tr>
<tr>
<td></td>
<td>• <strong>Used by</strong>: Discovery</td>
</tr>
<tr>
<td>Command</td>
<td>Purpose</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>fcinfo</td>
<td>Gets WWPNs for ports.</td>
</tr>
<tr>
<td></td>
<td>• /etc/sudoers line example: ${sudo:fcinfo remote-port -sl -p $port}</td>
</tr>
<tr>
<td></td>
<td>• Used by: Discovery</td>
</tr>
<tr>
<td>prvtoc</td>
<td>Reports information about disk partitions.</td>
</tr>
<tr>
<td></td>
<td>• /etc/sudoers line example: Disco ALL=(root) /usr/bin/prvtoc</td>
</tr>
<tr>
<td></td>
<td>• Used by: Discovery</td>
</tr>
<tr>
<td>/usr/bin/ps</td>
<td>Lists running process. As an alternative to running with root access, add a proc_owner role.</td>
</tr>
<tr>
<td></td>
<td>• /etc/sudoers line example: Disco ALL=(root) /usr/bin/ps</td>
</tr>
<tr>
<td></td>
<td>• Used by: Discovery</td>
</tr>
<tr>
<td>/usr/ucb/ps</td>
<td>Lists running process. As an alternative to running with root access, add a proc_owner role.</td>
</tr>
<tr>
<td></td>
<td>The use of the /usr/ucb/ps command is deprecated as of Solaris 11. Because Discovery, Orchestration, and IntegrationHub require the use of this command for all Solaris versions, you must install the ucb utility manually on Solaris 11 systems. For instructions, see KB0564262.</td>
</tr>
<tr>
<td></td>
<td>• /etc/sudoers line example: Disco ALL=(root) /usr/ucb/ps</td>
</tr>
<tr>
<td></td>
<td>• Used by: Discovery</td>
</tr>
</tbody>
</table>

For a list of privileged commands that you need for Discovery and Service Mapping, see #unique_601 for a list of the commands that require elevated rights to discover and map Unix-based hosts in your organization.

**Granting root privileges**

Use either of these approaches to allow users to run SSH commands with root privileges:

- Give root credentials. These are obviously the most powerful credentials, but may not be desirable from a security perspective. If Discovery, Orchestration, or IntegrationHub have the root credentials to any UNIX or Linux system, no further configuration is required.
- Give other credentials for Discovery, Orchestration, or IntegrationHub, but grant the user in those credentials the right to execute certain commands with root privileges, using sudo. This is a secure way to grant limited privileges. Discovery, Orchestration, or IntegrationHub use sudo on any probe that has the must_sudo parameter set to true (it defaults to false). However, each system must be configured to allow sudo to work. This is done by editing the /etc/sudoers file using the visudo command.

**Access Requirements for Non-Root Credentials**

If you do not provide Discovery with root access credentials, you must provide credentials with the following access requirements.

<table>
<thead>
<tr>
<th>Application</th>
<th>File or Directory</th>
<th>Access Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apache</td>
<td>httpd.conf</td>
<td>Read</td>
</tr>
<tr>
<td>Application</td>
<td>File or Directory</td>
<td>Access Required</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Hbase</td>
<td>hbase-site.xml</td>
<td>Read</td>
</tr>
<tr>
<td>JBoss</td>
<td>jboss-service.xml</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>JBoss home directory</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>web.xml</td>
<td>Read</td>
</tr>
<tr>
<td>MySQL</td>
<td>my.cnf</td>
<td>Read</td>
</tr>
<tr>
<td>NGINX</td>
<td>nginx.conf</td>
<td>Read</td>
</tr>
<tr>
<td>Oracle</td>
<td>oratab</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>Associated (s) pfiles</td>
<td>Read</td>
</tr>
<tr>
<td>Oracle Listener</td>
<td>lsnrctl</td>
<td>Execute</td>
</tr>
<tr>
<td></td>
<td>listener.ora</td>
<td>Read</td>
</tr>
<tr>
<td>Tomcat</td>
<td>catalina.jar</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>server.xml</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>web.xml</td>
<td>Read</td>
</tr>
<tr>
<td>Unix</td>
<td>/etc/*release</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>/etc/bashrc</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>/etc/profile</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>/proc/cpuinfo</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>/proc/vmware/sched/ncpus</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>/var/log/dmesg</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>APD directory</td>
<td>Read</td>
</tr>
<tr>
<td>WebSphere</td>
<td>cell.xml</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>server.xml</td>
<td>Read</td>
</tr>
<tr>
<td></td>
<td>serverindex.xml</td>
<td>Read</td>
</tr>
</tbody>
</table>

**SSH credential type**

These fields are available in the SSH credentials form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. For CIM discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The <strong>Credential ID</strong> field has a limit of 40 characters. This field is only visible when the <strong>External credential store</strong> check box is selected.</td>
</tr>
</tbody>
</table>
| Credential alias      | • Allow flow designers to use aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you do not need to update any actions that use the connection. For more information, see Credentials and connection information.  
  • Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow. To use the credential for discovering CIs not belonging to this CI type using Service Mapping and Discovery patterns, enter the table name for the CI type to which the CI belongs, for example cmdb_ci_apache_web_server. For more information, see Change credentials to non-default. |
| External credential store | Select this check box to use an external credential storage system. When you select this option the **User name** and **Password** fields are replaced with the **Credential ID** field. **External credential storage** is only available when the External Credential Storage plugin is activated.  
  **Note:** Currently, the only supported external storage system is CyberArk. |
| Applies to            | Select whether to apply these credentials to **All MID servers** in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the **MID servers** field. |
| MID servers           | Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select **Specific MID servers** from the **Applies to** field. |
### SSH private key credential type

**Note:** SSH private key credentials provide better security than SSH password credentials.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and descriptive name for this credential. For example, you might call it <strong>SSH Atlanta</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter a UNIX or Linux user name. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the UNIX or Linux password. For <strong>SSH Private Key</strong> type credentials, enter the sudo password if one is required for the user name.</td>
</tr>
<tr>
<td>SSH passphase</td>
<td>Type a secure SSH passphrase. This field is available only for <strong>SSH Private Key</strong> credentials.</td>
</tr>
<tr>
<td>Field</td>
<td>Input value</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **SSH private key**         | Enter a secure, private key that can be used instead of a password for SSH logins. The private key must be entered in the proper format to ensure it is correctly encrypted. The private key must start with the string ```-----BEGIN```.
|                             | Here is an example of a correctly formatted private key:```-----BEGIN RSA PRIVATE KEY-----MIIEogIBAAKCAQEAsEK65scPssPsobpDFMqFR+Btv3MS4Q7P8ERaStRzsh31Wz+x... ...7hrxV2dSuc60FahyupGbW6ptPnXm5PaE2X5WPLuUj9-----END RSA PRIVATE KEY-----``` The Now Platform supports private keys in the PEM format generated by the OpenSSH ssh-keygen utility. To convert PPK keys that were generated by PuTTY:  
|                             | • Open your private key in PuTTYGen.  
|                             | • Export it in OpenSSH format from the menu **Conversions > Export OpenSSH key**.  
|                             | • Save the new OpenSSH key.                                                                                                                                                                                                                                               |
| **Credential alias**        | • Allow flow designers to use aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you do not need to update any actions that use the connection. For more information, see Credentials and connection information.  
<p>|                             | • Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.                                                                                                                                               |
| <strong>External credential store</strong> | Select this check box to use an external credential storage system. When you select this option the <strong>User name</strong> and <strong>Password</strong> fields are replaced with the <strong>Credential ID</strong> field. Currently, the only supported external storage system is CyberArk.                                                                                       |
| <strong>MID servers</strong>             | Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select <strong>Specific MID servers</strong> from the <strong>Applies to</strong> field.                                                                                       |
| <strong>Applies to</strong>              | Select whether to apply these credentials to <strong>All MID servers</strong> in your network, or to one or more <strong>Specific MID servers</strong>. Specify the MID Servers that should use these credentials in the <strong>MID servers</strong> field.                                                                                                           |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>The order (sequence) in which the platform tries this credential as it attempts to log onto devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), Discovery or Orchestration tries the credentials in a random order.</td>
</tr>
</tbody>
</table>

**VMware credentials**

The VMware credentials type manages access to vCenter credentials.

Applications that access VMware cloud resources need access to VMware credentials. For example, the VMware credential type allows Discovery to explore VMware’s vCenter running on a Windows machine to discover ESX machines, virtual machines, and resource pools. The VMware Discovery and automation API (vCenter API) now provides the globally unique serial number for computer CIs. CIM credentials are not needed to allow access to each VMware host.

**Note:** Windows credentials are not necessary for vCenter Discovery, when valid VMware credentials are used.

**Important:** Do not use VMware Type credentials for Orchestration activities that perform work on the individual virtual machines cloned by vCenter (for example, restarting a Linux VM). For these activities, the credential Type depends on the operating system of the virtual machine (either SSH or Windows).

**VMware credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for the VMware credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name you use for your VMware account. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. The VMware credentials must have the read-only role in vCenter.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for the VMware account.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select Specific MID servers from the Applies to field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
</tbody>
</table>

Windows credentials

Windows credentials provide access to Windows computers. This credential type is available for Discovery and Orchestration.

Credential requirements

Discovery and Orchestration have the following requirements for Windows credentials:

- Install a MID Server on a Windows host as a service.
- Add Windows credentials to one of these locations:
  - An entry in the Credentials [windows_credentials] table
  - A MID Server service account to run as a specific Windows user or domain account.

Granting proper permissions

To provide sufficient permissions, Windows credentials must be one of the following:

- A domain user with local administrator access on the target Windows hosts.
- A local account that has administrator privileges and User Access Control (UAC) disabled on the same target host.
- A user who meets the requirements of Windows probes and permissions (Discovery only).
- A user who meets the requirements of the Orchestration activity to be run (Orchestration only).

Note: No logon privileges are needed. Account does NOT need to be interactive.

Security around granting privileged access can be enhanced by using JEA profiles to run Discovery. For more information, see Microsoft Just Enough Administration (JEA) for Discovery.

Workgroup computers

To run Powershell commands to discover a Workgroup computer, configure the MID Server credentials for either of these users:

- Built-in administrator account on the Workgroup computer.
- Domain user on the Workgroup computer.
Multi-domain configuration

To enable Windows credentials to function across multiple domains, make sure to use the correct name formats and MID Server configuration.

Discovery and Orchestration support Windows domain credentials in both User Principal Name and Down-Level Logon Name user name formats. For example, Domain\UserName or UserName@example.domain.com. You can provide Windows workgroup credentials in the following format: WORKGROUP\UserName.

Note: You can also provide a local account by using the .\user name.

These additional actions are required to enable credentials to function across multiple Windows domains.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Additional actions required</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server host on the same domain as the Windows target.</td>
<td>None</td>
</tr>
<tr>
<td>MID Server host on a different domain than the Windows target.</td>
<td>Ensure that Powershell 2.0 or higher is installed on the MID Server host.</td>
</tr>
<tr>
<td>MID Server host on a different domain than the Microsoft SQL Server target.</td>
<td>See MSSQL server discovery.</td>
</tr>
</tbody>
</table>

Windows credentials type

These fields are available in the Credentials form for Windows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name to create in the Credentials table. Avoid leading or trailing spaces in user names. A warning appears if the platform detects leading or trailing spaces in the user name. For CIM discovery, the user must have the admin role.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. The Credential ID field has a limit of 40 characters. This field is only visible when the External credential store check box is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow. To use the credential for discovering CIs not belonging to this CI type using Service Mapping and Discovery patterns, enter the table name for the CI type to which the CI belongs, for example cmdb_ci_apache_web_server. For more information, see Change credentials to non-default.</td>
</tr>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. External credential storage is only available when the External Credential Storage plugin in activated. Note: Currently, the only supported external storage system is CyberArk.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field.</td>
</tr>
<tr>
<td>MID servers</td>
<td>Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select Specific MID servers from the Applies to field.</td>
</tr>
<tr>
<td>Order</td>
<td>Order (sequence) in which Discovery tries this credential as it attempts to log on to devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), the instance tries the credentials in a random order.</td>
</tr>
</tbody>
</table>

Configure Windows credentials for the MID Server

Configure the MID Server to use either the credentials of its own Windows service or credentials from the Credentials [discovery_credentials] table.
Role required: admin

1. Configure the MID Server to use credentials from the MID Server service account.
   a) Set the MID Server service account to a user who meets the permission requirements.
   b) Verify the user name meets the name format requirements.
   c) Fill in the fields on the form, as appropriate.
   d) Verify the credentials meet domain requirements.

2. Configure the MID Server use credentials from the Credentials [discovery_credentials] table.
   a) Add individual Windows credentials to the Credentials [windows_credentials] table.
      • Verify each credential meets the permission requirements.
      • Verify each username meets the name format requirements.
      • Verify each credential meets the Windows domain requirements.
   b) [Optional] Configure the MID Server to use Powershell by setting the mid.use_powershell parameter to true. See MID Server Configuration.
   c) [Optional] By default, Discovery automatically uses the MID Server service account credentials if all credentials in the Credentials table fail. If you do not want to use the MID Server service credentials as a fall back, set the mid.powershell.local_mid_service_credential_fallback parameter to false.

Credential affinity for Discovery and Orchestration

Credential affinity is an association between a set of credentials and a device on your network.

When Discovery or Orchestration first attempts to access a device, they try all available credentials until they find the correct ones. After identifying the credentials for a device, Discovery and Orchestration create an affinity between the credentials and the device using the Credential Affinity [dscy_credentials_affinity] table. All subsequent discoveries or Orchestration activities attempt to match the credentials in this table with a device for which an affinity exists. If credentials for a device change, Discovery and Orchestration try all available credentials again until they create a new affinity.
Note: If Orchestration and Discovery are installed, and credential alias is enabled, multiple affinities can exist. In this case, the platform looks up credentials for each affinity and inserts the credential for the affinity with the lowest order into the probe.

Credentials troubleshooting

Review the `<credentials_debug>` section of the ECC queue payload to troubleshoot issues with credentials.

Certain probes support credential debugging. Credential debugging inserts a `<credentials_debug>` section in the payload that the MID Server returns to the instance ECC queue. You can view the `<credentials_debug>` section to see detailed information about the credential lookup.

The `<credentials_debug>` section appears in the payload if:

- Credentials fail for WMIRunner probe, PowerShell probe, JMS, or SSHCommand probe.
- You set the `credentials_debug` parameter to `true` for the WMIRunner, PowerShell, or SSHCommand probes. If you set the parameter to `true`, the `<credentials_debug>` section appears even if the credential lookup is successful.

The `<credentials_debug>` section shows:

- Information about the credential search, such as the credential types, tags, and affinities.
- The IP address targeted.
- Information about each credential (in order) that the MID Server used, including the type, classification, tag, name, Sys ID, and external credential ID if present.
Sample payload showing invalid credentials

Details appear for the PowerShell parameter:

- If the local MID Server credentials were used after all the Windows credentials failed.
- If the credentials were skipped because you are trying to discover the same machine that the MID Server is on.
- If the `mid.powershell.use_credentials` parameter is set to `true`.

Details appear for the SSHCommand:

- If the credential search was skipped because the target IP is blacklisted.
- If the target IP was added to the blacklist.
Note: The MID Server saves IP addresses for failed credential searches in a blacklist in cache memory. This blacklist specifies which devices the MID Server should stop trying to access. IP addresses are added to the blacklist after every credential has failed. The IP addresses are cleared from the blacklist cache either after five minutes, if the MID Server is restarted, or if the credential records on the instance are updated.

External credential storage

An instance can store credentials used by Discovery, Orchestration, and Service Mapping in an external credential repository rather than directly in a ServiceNow credentials record.

The instance maintains a unique identifier for each credential, the credential type (such as SSH, SNMP, or Windows), and any credential affinities. The MID Server obtains the credential identifier from the instance, and then uses a customer-provided JAR file to resolve the identifier from the repository into a usable credential. Currently, the ServiceNow® platform supports the use of the CyberArk vault for external credential storage.
External credential storage architecture
Credential process flow

The MID Server retrieves credentials from an external store using this process:

1. MID Server downloads credential objects from the ServiceNow Credentials [discovery_credentials] table that contain the corresponding credential ID from the target vault.

2. As each probe or pattern runs from Discovery or Orchestration jobs, the MID Server requests the credential by passing information such as credential ID, target IP address, and credential type to the Credential Resolver Java Jar file. The details about the correct credential object to retrieve from the vault are determined by the Credential Resolver.

   Many Credential Resolvers such as CyberArk call an application supplied by the third-party vault vendor running on the same machine as the MID Server. That application can often be configured to cache credentials and knows to update the cache when a credential changes in the vault, which is very important to avoid unnecessary network calls to the vault each time MID Server requests a credential. The Credential Resolver (using optional vendor application if present) makes a call to the vault to get the actual user name, password, etc.

   For Credential Resolvers supplied out-of-box (only CyberArk today), the MID Server only caches a credential for up to several seconds using encryption in MID Server process memory. This means the MID Server can make multiple requests to the Credential Resolver for the same credential even when discovering a single device. Contact third-party vendors for information about caching implementations for other Credential Resolvers.

3. MID Server executes the probe with the appropriate credential.

   Note: Credential affinity still applies. The mechanism remains the same, since the only real difference from the MID Server’s perspective is that the real credential details (user name and password) come from the third-party vault.

External credential storage logging

The MID Server posts log messages about external credential storage.

If the repository encounters an error while attempting to resolve a credentials request, the MID Server posts log messages with this prefix: `Problem with client's CredentialResolver:`

Components installed with External Credential Storage

Business rule

The External Credential Storage business rule performs the following tasks when an administrator makes any change to the Enable External Credential Storage property:

- Changes the view for the Credentials record list and form to the External Storage view. This view enables users to see the Credential ID column in the list.
- Instructs the MID Server to refresh its credentials cache in preparation for a change in the way credentials are obtained.

Property

A property called Enable External Credential Storage [com.snc.use_external_credentials] enables or disables the External Credential Storage plugin after it is activated. The property is located in Discovery.
Definition > Properties and Orchestration > MID Server Properties, and is enabled when you activate the plugin.

If you disable external credential storage with the system property, the system automatically sets all the external credentials to inactive in the instance. If you re-enable the feature with this property, the system does not reset the external credential records to active. You must reactivate each credential record manually.

Request external credential storage for Discovery and Orchestration

The External Credential Storage plugin is available by request.

Role required: admin

There are two ways to request a plugin:

• Access the HI Service Catalog directly by clicking Service Catalog > Activate Plugin on HI.
• Access the HI Service Catalog through the All Applications page on your instance by following these steps.

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click **Request Plugin** to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.

4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**External credential storage configuration**

Configure your instance to obtain credentials from a remote repository.

These procedures assume that you already have an external repository configured with the credentials you want to protect. The credential identifier configured in the ServiceNow instance must be mapped to the actual credential in the repository through the JAR file.

To configure External Credential Storage, complete the following tasks in order.

*Create a JAR file to resolve credentials*

Create a JAR file to resolve credential identifiers sent from the MID Server into actual credentials from the repository.

Make sure to include all the credential elements that the instance expects, such as the private key.

To create a JAR file to resolve credentials:

Use this sample Java file as a template:
**Caution:** This sample is intended as a template only. Do NOT use this code in production without modifying it for your environment.

```java
package com.snc.discovery;

import java.util.*;
import java.io.*;

/**
 * Basic implementation of a CredentialResolver that uses a properties file.
 */
public class CredentialResolver {

    private static String ENV_VAR = "CREDENTIAL_RESOLVER_FILE";
    private static String DEFAULT_PROP_FILE_PATH = "C:\dummycredentials.properties";

    // These are the permissible names of arguments passed INTO the resolve() method.
    public static final String ARG_ID = "id";
    public static final String ARG_IP = "ip";
    public static final String ARG_TYPE = "type";
    public static final String ARG_MID = "mid";

    // These are the permissible names of values returned FROM the resolve() method.
    public static final String VAL_USER = "user";
    public static final String VAL_PSWD = "passwd";
    public static final String VAL_PASSPHRASE = "passphrase";
    public static final String VAL_PKEY = "pkey";
    public static final String VAL_AUTHPROTO = "authprotocol";
    public static final String VAL_AUTHKEY = "authkey";

    // the string identifier as configured on the ServiceNow instance...
    public static final String ARG_ID = "id";
    public static final String ARG_IP = "ip";
    public static final String ARG_TYPE = "type";
    public static final String ARG_MID = "mid";

    // the string user name for the credential, if needed...
    public static final String VAL_USER = "user";
    public static final String VAL_PSWD = "passwd";
    public static final String VAL_PASSPHRASE = "passphrase";
    public static final String VAL_PKEY = "pkey";
    public static final String VAL_AUTHPROTO = "authprotocol";
    public static final String VAL_AUTHKEY = "authkey";

    // the string privacy protocol for the credential, if needed...
```
```java
public static final String VAL_PRIVPROTO = "privprotocol";
// the string privacy key for the credential, if needed...
public static final String VAL_PRIVKEY = "privkey";

private Properties fProps;

public CredentialResolver() {
}

private void loadProps() {
if (fProps == null)
    fProps = new Properties();

try {
    String propFilePath = System.getenv(ENV_VAR);
    if (propFilePath == null) {
        System.err.println("Environment var " + ENV_VAR + " not found. Using default file: "+DEFAULT_PROP_FILE_PATH);
        propFilePath = DEFAULT_PROP_FILE_PATH;
    }
    else {
        InputStream propsIn = new FileInputStream(propFilePath);
        fProps.load(propsIn);
        File propFile = new File(propFilePath);
        if (!propFile.exists() || !propFile.canRead()) {
            System.err.println("Can't open " + propFile.getAbsolutePath());
        } else {
            fProps.load(CredentialResolver.class.getClassLoader().getResourceAsStream("dummycredentials.properties"));
        }
    }
}

fProps.load(CredentialResolver.class.getClassLoader().getResourceAsStream("dummycredentials.properties"));
} catch (IOException e) {
    System.err.println("Problem loading credentials file:");
    e.printStackTrace();
}

/**
 * Resolve a credential.
 */
public Map resolve(Map args) {
    loadProps();
    String id = (String) args.get(ARG_ID);
    String type = (String) args.get(ARG_TYPE);
    String keyPrefix = id + "." + type + ".";
    if (id.equalsIgnoreCase("misbehave")
        throw new RuntimeException("I've been a baaaaaaaaad CredentialResolver!");

    // the resolved credential is returned in a HashMap...
    Map result = new HashMap();
    result.put(VAL_USER, fProps.get(keyPrefix + VAL_USER));
    result.put(VAL_PSWD, fProps.get(keyPrefix + VAL_PSWD));
    result.put(VAL_PKEY, fProps.get(keyPrefix + VAL_PKEY));
    result.put(VAL_PASSPHRASE, fProps.get(keyPrefix + VAL_PASSPHRASE));
    result.put(VAL_AUTHPROTO, fProps.get(keyPrefix + VAL_AUTHPROTO));
    result.put(VAL_AUTHKEY, fProps.get(keyPrefix + VAL_AUTHKEY));
    result.put(VAL_PRIVPROTO, fProps.get(keyPrefix + VAL_PRIVPROTO));
    result.put(VAL_PRIVKEY, fProps.get(keyPrefix + VAL_PRIVKEY));

```

System.err.println("Error while resolving credential id/type["+id +"/"+type+"]");

return result;
}

/**
 * Return the API version supported by this class.
 */
public String getVersion() {
    return "1.0";
}

public static void main(String[] args) {
    CredentialResolver obj = new CredentialResolver();
    obj.loadProps();

    System.err.println("I spy the following credentials: ");
    for(Object key: obj.fProps.keySet()) {
        System.err.println(key+": "+obj.fProps.get(key));
    }
}

Import a JAR file to resolve credentials

Import a JAR file created to resolve credential identifiers sent from the MID Server into actual credentials from the repository.

After you create the JAR file, import it into the instance, where it becomes accessible to the MID Server.

1. After creating the JAR and properties files, copy the properties file to the MID Server.
2. Navigate to MID Server > JAR Files.
3. Click New.
4. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique and descriptive name for identifying the file in the instance.</td>
</tr>
<tr>
<td>Version</td>
<td>A version number for the file, if one is available.</td>
</tr>
<tr>
<td>Source</td>
<td>Location of the JAR file for reference purposes. Source information is not used by the system.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the JAR file and its purpose in the instance.</td>
</tr>
</tbody>
</table>
5. Click the paper clip icon in the banner and attach the JAR file to the record.

6. Click **Submit**.

7. Restart the MID Server service.

   The platform makes the JAR file available to any MID Server configured to communicate with the instance.

Configure the credential identifier
Configure the credential identifier in the instance.

Role required: admin

Verify the following items:

- The **External Credential Storage** plugin must be active.
- The **Enable External Credential Storage Discovery** property is enabled.

1. Navigate to **Discovery > Credentials** or **Orchestration > Credentials**.

2. Click **New**.

3. Select a credential type.

4. Select the **External credential store** check box.

   The **User name** and **Password** fields disappear, and the **Credential ID** field appears.

5. Complete the Credentials form using the fields from the table.

6. Click **Submit**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique and descriptive name for this credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable these credentials for use.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Credential ID          | Enter the unique key configured for external credentials in the JAR file uploaded to the MID Server for an external credential system. This is the ID passed to the Java class in the parameter map:  
  ```java
  public static final String ARG_ID = "id";
  ```  
The MID Server uses this identifier to resolve the actual credentials on the repository. |
| Note                   | This field is only visible when the External credential store check box is selected.                                                       |
| Tag                    | Allow workflow creators to assign individual credentials to any activity in an Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow. |
| External credential store | Select this check box to use an external credential storage system. When you select this option the User name and Password fields are replaced with the Credential ID field. External credential storage is only available when the External Credential Storage plugin is activated. |
| Note                   | Currently, the only supported external storage system is CyberArk.                                                                         |
| Applies to             | Select whether to apply these credentials to All MID servers in your network, or to one or more Specific MID servers. Specify the MID Servers that should use these credentials in the MID servers field. |
| MID servers            | Select one or more MID Servers from the list of available MID Servers. The credentials configured in this record are available to the MID Servers in this list. This field is available only when you select Specific MID servers from the Applies to field. |
| Order                  | Enter the order (sequence) in which the platform tries this credential as it attempts to log onto devices. The smaller the number, the higher in the list this credential appears. Establish credential order when using large numbers of credentials or when security locks out users after three failed login attempts. If all the credentials have the same order number (or none), Discovery or Orchestration tries the credentials in a random order. |

**Configure the credential identifier for AWS**

Configure your instance to obtain credentials from a remote repository.
Role required: cloud_admin

Verify that these plugins are active, and the MID Server has been installed:

- Discovery [com.snc.discovery]
- Cloud Management [com.snc.cloud.mgmt]
- External Credential Storage [com.snc.discovery.external_credentials]

These procedures assume that you already have an external repository configured with the credentials you want to protect. The credential identifier configured in the ServiceNow instance must be mapped to the actual credential in the repository through the JAR file.

1. Navigate to Discovery > Credentials.
2. Select a credential that your external credential storage provider supports.
3. Complete the form, using the fields from the table.

**AWS Credentials**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique and descriptive name for this credential. For example, Amazon Web Services.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use these credentials. The choices are All MID Servers or Specific MID Servers. If you select the latter, the MID Servers field appears.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to enable or disable the credential.</td>
</tr>
<tr>
<td>AWS Account</td>
<td>Master AWS account to which this credential belongs.</td>
</tr>
<tr>
<td>External credential store</td>
<td>Select this check box to use an external credential storage system. When external storage is enabled, the Credential ID field appears. If this check box is not visible, click the menu icon in the header bar and select View &gt; External Storage from the context menu.</td>
</tr>
<tr>
<td>Credential ID</td>
<td>Enter the Name under which this credential is stored in the external credential storage provider.</td>
</tr>
<tr>
<td>MID servers</td>
<td>Select one or more MID Servers.</td>
</tr>
</tbody>
</table>

4. Click Submit.

**CyberArk credential storage integration**

The MID Server integration with the CyberArk vault enables Orchestration, Discovery, and Service Mapping to run without storing any credentials on the instance.

**Introduction to CyberArk**

CyberArk’s Application Identity Management (AIM) product uses the Privileged Account Security solution to eliminate the need to store application passwords embedded in applications, scripts or configuration files, and allows these highly-sensitive passwords to be centrally stored, logged and managed within the CyberArk vault. This approach enables organizations to comply with internal and regulatory requirements of periodic password replacement and to monitor activities associated with all types of privileged identities, whether on-premise or in the cloud.

The instance maintains a unique identifier for each credential, the credential type (such as SSH, SNMP, or Windows), and any credential affinities. The MID Server obtains the credential identifier, credential type, and IP address from the instance, and then uses the CyberArk vault to resolve these elements into a usable credential.
The CyberArk integration requires the ServiceNow® External Credential Storage plugin, which is available in System Definitions > Plugins. The MID Server and CyberArk AIM/API client must be installed on the same machine.

Installed with CyberArk

- **Business rule**: The External Credential Storage business rule performs the following tasks when an administrator makes any change to the external credential storage property:
  - Changes the view for the Credentials record list and form to the External Storage view. This view enables users to see the Credential ID column in the list.
  - Instructs the MID Server to refresh its non-external credentials cache in preparation for a change in the way credentials are obtained.

- **System property**: A property called Enable External Credential Storage [com.snc.use_external_credentials] enables or disables the External Credential Storage plugin after it is activated. This property is located in Discovery Definition > Properties and Orchestration > MID Server Properties, and is enabled when you activate the plugin.

  **Note**: If you disable external credential storage with the system property, the system automatically sets all the external credentials to inactive in the instance. If you re-enable the feature with this property, the system does not reset the external credential records to active. You must reactivate each credential record manually.

Supported credential types

The CyberArk integration supports these ServiceNow credential types:

- CIM
- JMS
- SNMP forum
- SSH
- SSH Private Key (with key only)
- VMware
- Windows

Orchestration activities that use these network protocols support the use of credentials stored on a CyberArk vault:

- SOAP (with basic authentication overrides)
- REST (with basic authentication overrides)
- JDBC
- SSH
- PowerShell
- JMS
- SFTP

**Important**: You cannot manage credentials stored on a CyberArk vault and a custom external credential storage system using the same MID Server. The MID Server and CyberArk AIM/API client must be installed on the same machine.
CyberArk architecture

![Diagram of CyberArk architecture]
How the MID Server handles Windows accounts

Credential lookup initially attempts to match the specified credential ID to an existing value in the CyberArk vault **Name** field. If a match is found, that credential is returned. If no match is found, the credential lookup attempts to find a match using the IP address. If the IP address lookup matches more than one credential, such as Windows and Tomcat on the same server, the lookup fails. To avoid this issue, set the **ext.cred.typeSpecifier** parameter in the MID Server config.xml file to **true** to force CyberArk to return credentials that match both the credential type and the IP address. For example, if an IP address is shared by both Windows and Tomcat, a credential type of Windows returns the Windows credential only.

**CyberArk integration configuration**

These procedures include both CyberArk and ServiceNow configuration tasks, including references to the appropriate CyberArk documentation.

The credential identifier configured in the ServiceNow instance must be mapped to the credential name in the CyberArk vault. When looking up a credential, the MID Server finds the credential by matching the credential identifier to a name in vault, which must be unique. If the credential identifier is blank, then the MID Server finds the credential by IP address. To identify the credential by IP address, the system looks at the credential type to ensure that there is only one credential of that type at that address. An example of this might be when a Windows server and vCenter are both running on the same IP address. To support strict credential requirements like this in an SSH environment, a MID Server configuration parameter allows you to require that the credential type requested matches the type returned by CyberArk.

To configure your instance to obtain credentials from a CyberArk vault, complete these tasks in the order in which they appear below.

**Configure the CyberArk vault and install the AIM API**

Configure the CyberArk vault to allow MID Server access and install the CyberArk AIM API on the MID Server machine.

Role required: admin

Before starting this procedure, ensure that the **External Credential Storage plugin** is activated.

1. Configure the CyberArk vault with the application ID and authentication details that all MID Servers requesting credentials will use.
   For details, refer to the CyberArk Credential Provider and ASCP Implementation Guide.
   a) Ensure that CyberArk is configured to allow the MID Server to access the vault by creating an App-ID in CyberArk called **ServiceNow_MID_Server**.
   b) Make sure that every credential the MID Server needs is granted access to the **ServiceNow_MID_Server** App-ID.

   **Note:** You can override the default **ServiceNow_MID_Server** App-ID in the MID Server config.xml file using the ext.cred.app_id parameter. If you change the value in this parameter, make sure to configure a matching value in the vault.

2. Install the CyberArk Credential Provider, including the AIM API, on each machine that hosts a MID Server service that is used to access the credential store.
3. Provision CyberArk accounts and set permissions for application access.
   For details, refer to the CyberArk Privileged Account Security Implementation Guide.
   a) In the CyberArk Password Safe, create the privileged accounts required by Discovery,
      Orchestration, or Service Mapping to access different devices and ensure that these accounts are
      members of the safes in which the necessary credentials are stored.
   b) Add the Credential Provider and application users as members of the Password Safes where the
      application passwords are stored.

Import the CyberArk JAR file
Import the CyberArk JavaPasswordSDK.jar file into the instance to make it accessible to the MID Server.
Role required: agent_admin or admin
Before starting this procedure, ensure that CyberArk is configured to allow the MID Server access to
credentials. Ensure that the CyberArk AIM API is installed on each server hosting a MID Server that is
used to access the vault.

Use this process even if the JavaPasswordSDK.jar file already exists on the MID Server.
1. Navigate to **MID Server > JAR Files**.
2. Click **New**.
3. Complete the form using the fields in the table.

   **JAR File form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and descriptive name for identifying the file in the instance.</td>
</tr>
<tr>
<td>Version</td>
<td>Optional version number for the file, if one is available.</td>
</tr>
<tr>
<td>Source</td>
<td>Provider of the JAR file. Source information is not used by the system.</td>
</tr>
<tr>
<td>Description</td>
<td>Optional short description of the JAR file and its purpose in the instance.</td>
</tr>
</tbody>
</table>

4. Attach the JAR file to this record.
The AIM JavaPasswordSDK.jar file comes with the AIM SDK installation files and is typically
located on the MID Server in the AIM installation directory at <install_dir>/CyberArk/
ApplicationPasswordSdk.
5. Click **Submit**.
6. Restart the MID Server service.
   The platform makes the JAR file available to any MID Server configured to communicate with the
   instance.

Configure the MID Server for CyberArk
Configure the config.xml file to grant the MID Server access to the CyberArk vault.
Role required: admin
Before starting this procedure, import the `JavaPasswordSDK.jar` file into the instance.

Manually configure the MID Server `config.xml` file with these parameters. This configuration cannot be done from the instance.

### Required configuration parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ext.cred.safe_folder</td>
<td>NameOfFolder</td>
<td>Folder to use for all credential lookups. For example, <code>root</code>.</td>
</tr>
<tr>
<td>ext.cred.use_cyberark</td>
<td>true</td>
<td>Boolean parameter indicating that this MID Server is integrated with CyberArk.</td>
</tr>
</tbody>
</table>

### Optional configuration parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ext.cred.safe_timeout</td>
<td>5 (sec)</td>
<td>Timeout of each credential lookup in the vault, specified in seconds.</td>
</tr>
<tr>
<td>ext.cred.safe_name</td>
<td>NameOfSafe</td>
<td>Default safe name used for all credential lookups. If parameters are in multiple safes, the credential ID may be specified in the format <code>&lt;safeName&gt;:&lt;CredentialID&gt;</code>. When configured like this, the <code>NameOfSafe</code> field is ignored. If all external credentials have their credential IDs specified in this format, then leave out the <code>NameOfSafe</code> field.</td>
</tr>
<tr>
<td>ext.cred.app_id</td>
<td>ServiceNow_MID_Server</td>
<td>Specifies the App-ID used to grant permission to the MID Server to access the CyberArk vault. The default value, <code>ServiceNow_MID_Server</code>, must be defined in the CyberArk vault. You can use this parameter to override the default and specify your own App-ID. If you edit the App-ID in this parameter, make sure to configure CyberArk to match.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| ext.cred.typeSpecifier | true  | Forcing an IP address lookup to return credentials that match both the CyberArk platform ID and the IP address. For example, if an IP address is shared by both Windows and Tomcat, a credential with a platform ID starting with **Win** returns the Windows credential only. When this parameter is set to true, CyberArk looks for platform IDs that begin with:  
  • Win: Windows  
  • Unix: SSH  
  • VMWare: VMware |
| ext.cred.check_ssh_type | false | When set to true, requires that the type of SSH credential returned from CyberArk matches the type of credential requested. For example, if a normal SSH username/password credential is requested and only SSH keys are available, the credential lookup fails. |

**Configure CyberArk for SNMPv2 credentials**

If your system uses SNMPv2, you can create a special file to map the attribute in a credential to the community string.

Role required: admin

Before starting this procedure, configure the MID Server to have access to the CyberArk vault.

**Note:** If the community string appears in the password field of the CyberArk credential, it is not necessary to perform this procedure.

SNMPv2 is not natively supported in CyberArk. If your organization has created custom SNMPv2 credentials in which the community string does not appear in the password field of the credential, use this procedure to map the attribute in the credential to the community string.

1. In a text editor, create a file called **CredMap.properties**, containing this code:
   ```properties```
   ```
   SNMPv2.Community=attribute_name
   ```
   2. Save the file to the `/agent` directory of your MID Server installation.

   On credential lookup, the MID Server attempts to find this attribute for the credential. If the attribute is not found, the MID Server then looks in the password field. If the password field is empty, the credential lookup fails.

**Configure the CyberArk credential identifier**

Create the unique key that CyberArk can use to identify specific credentials in the external repository.

Role required: admin
Before starting this procedure, ensure that the External Credential Storage plugin is activated, and the `com.snc.use_external_credentials` system property is set to true.

1. Navigate to Discovery > Credentials or Orchestration > Credentials.
2. Click New.
3. From the list of credential types, select a type that supports CyberArk external storage.
4. Complete the form using the fields from your credential type.
5. Select the External credential storage check box.

The User name and Password fields are replaced with the Credential ID field.

6. In the Credential ID field, enter an expression using one of these formats:
   - If all your credentials are in the same safe, configure this safe name in the MID Server config.xml file using the `ext.cred.safe_name` parameter, and then specify the credential ID by name only, as `<credential ID>`.
   - To name credentials for a given platform that reside in a specific safe, define the credential ID as `<safe>:<credential ID>:<platform ID>`.
   - If your credentials are in multiple safes, specify the credential ID in this format: `<safe><credential ID>`.
   - If you want CyberArk to look up the credential by IP address, using an alternate safe, specify the credential ID in this format: `<safe>`.
   - If you want CyberArk to look up the credential for an alternate platform ID in the same safe, use this format: `::<platform ID>`.
   - If you want CyberArk to look up the credential in a configured safe by the IP address rather than the credential ID, leave this field blank. This is the best practice for handling installations in which each server has a unique credential. Without this type of lookup, you must create a credential ID record in your instance for every server in your environment.

   **Note:** The credential ID must match the value in the Name field of the credential in the CyberArk vault. The Credential ID field has a limit of 40 characters.

7. Click Submit.

Configure AWS credentials on a CyberArk vault

Configure your CyberArk vault with the AWS credentials to be retrieved for use by your instance.

Store the credentials as an SSH key on the CyberArk vault. When you configure access to the vault on your instance, the name you give to the SSH key must also be used as the credential ID.

1. In CyberArk, go to Accounts > Add SSH Key.
2. Enter the following information:

   **CyberArk credentials**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Type</td>
<td>Select Cloud Service.</td>
</tr>
<tr>
<td>Platform Name</td>
<td>Select Amazon Web Services - AWS - Access Keys.</td>
</tr>
<tr>
<td>AWS Access Key ID</td>
<td>Enter the AWS Access Key, as provided by AWS.</td>
</tr>
<tr>
<td>AWS IAM Username</td>
<td>Enter the AWS IAM Username, as you configured in CyberArk.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the AWS Secret Access Key, as provided by AWS.</td>
</tr>
</tbody>
</table>
3. Choose **Save**.

If you have not done so already, create a credential identifier on your instance to configure access to the CyberArk vault. For more details, see **Configure access to external credential storage for AWS**.

**Credential alias for Orchestration activities**

Credential alias gives an administrator more control over the credentials used in Orchestration activities. This is useful when an activity requires specific credentials to perform a task. You can use a credential tag to assign individual credentials to any activity in a Orchestration workflow or assign different credentials to each occurrence of the same activity type in an Orchestration workflow.

Credential alias interacts with **credential affinity** to determine which credentials should be used for an Orchestration activity.

**How credential alias works**

A business rule called **Insert Discovery Affinity** (renamed from Insert Credential Affinity in the Geneva release) runs when a record is inserted into the ECC Queue. This rule determines whether a credential affinity exists for the device and identifies the proper **credential_id** (the **sys_id** of the record in the Credentials [discovery_credentials] table) to use. When the platform encounters an affinity with a credential alias value defined (**credential_alias** in the business rule), the business rule determines if the credential referenced by the affinity has the specified alias. If it does, the business rule selects the **credential_id** of the credential alias and passes that value to the MID Server. If the credential does not have the specified credential alias, any other affinities that exist for the target system will be checked. If no affinity references an appropriately tagged credential, the MID Server iterates through the Credentials [discovery_credentials] table and selects the credential with the appropriate tag. The MID Server then creates a new affinity for this credential.

**Check IP service affinity for Discovery and Orchestration**

You can check the IP Services table for a list of IP addresses that are associated with a protocol.

**Role required:** admin

The IP Services table maps a port to a protocol. Several mappings are provided by default for commonly used port-protocol combinations, such as port 80 for HTTP, port 22 for SSH, and port 161 for SNMP.

A system property called **glide.discovery.ip_service_affinity** allows Discovery to remember the last port of the IP address that was discovered. This property is set to **false** by default.

**Caution:** You should not modify IP services unless your organization uses custom ports.

1. Navigate to **Discovery Definition > IP Services**.
2. Filter the list to find the appropriate IP service.
3. Click the name of the service to go to that IP service page.
4. Click the **IP Service Affinities** tab for the list of IP addresses associated with that service.
Data Certification

Data Certification manages scheduled and on-demand validations of the configuration management database (CMDB) data.

Information is added to the CMDB by Discovery, by importing from third-party tools, or manually. For regulatory or procedural reasons, information in the CMDB requires checks for accuracy and certification. The person or team responsible for certification can define what information requires verification and a verification schedule. The schedule then generates a checklist for verifying the data. Individuals assigned to certification tasks answer a series of questions to verify the data.

Data certification can be performed against specific fields on specific tables. Based on the certification schedule, certification tasks are automatically created and assigned. For example, you can set up a certification to validate key information fields, such as Operating System and CPU count, on all Windows servers located in Chicago. You can then assign the tasks to the appropriate team member automatically.

Domain separated systems can use the Data Certification application.

Activate Data Certification

Activate the Data Certification plugin to access the application. Activating this plugin also activates the Version Management plugin, which manages certification filter versions.

Role required: admin

For plugin activation steps, see Activate a plugin.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Installed With Data Certification

Activating the Data Certification plugin installs the following components.

Demo data is available with Data Certification. The demo data provides information including filters, schedules, instances, and tasks.

Tables

Data Certification adds the following tables:

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certification Audit Definition [cert_audit_definition]</td>
<td>Stores collections of certification schedules that can be run as a single entity.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Certification Audit Definition Elements [m2m_cert_audit_def_cert_sched]</td>
<td>Lists the certification schedules in each certification audit definition.</td>
</tr>
<tr>
<td>Certification Audit Instance [cert_audit_instance]</td>
<td>Stores the certification instances associated with a specific audit definition.</td>
</tr>
<tr>
<td>Certification Element [cert_element]</td>
<td>Stores the data elements that are grouped into certification tasks.</td>
</tr>
<tr>
<td>Certification Filter [cert_filter]</td>
<td>Stores the data that requires certification using a filtering condition for the certification.</td>
</tr>
<tr>
<td>Certification Instance [cert_instance]</td>
<td>Stores a collection of certification tasks representing a single instance of a scheduled certification. This table extends the Audit [cert_audit] table.</td>
</tr>
<tr>
<td>Certification Schedule [cert_schedule]</td>
<td>Stores certification for a specific set of information on a specific table, what user or group the tasks are assigned to, and how often this certification is done.</td>
</tr>
</tbody>
</table>

**Script Includes**

Data Certification adds the following script includes:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CertificationAjax</td>
<td>Provides utilities that enable individual certification elements to be certified, rejected, or reverted.</td>
</tr>
<tr>
<td>CertificationTaskCreate</td>
<td>Custom code that extends the standard code for certification tasks.</td>
</tr>
<tr>
<td>CertTaskEscalationTimerPercentage</td>
<td>Updates time and percentage complete information for a certification.</td>
</tr>
<tr>
<td>CertificationUtilities</td>
<td>Provides utility functions for certification.</td>
</tr>
</tbody>
</table>

**Client Scripts**

Data Certification adds the following client scripts:

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert If Boxes Checked</td>
<td>Certification Task [cert_task]</td>
<td>Provides a warning if the certifier attempts to leave a record without certifying the checked elements</td>
</tr>
<tr>
<td>Check Table Name</td>
<td>Certification Schedule [cert_schedule]</td>
<td>Updates the table name when a different filter is selected.</td>
</tr>
</tbody>
</table>
UI Policies

Data Certification adds the following UI policies:

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide next scheduled run</td>
<td>Certification Schedule</td>
<td>Hides the Next Scheduled Run field when the schedule is set to run once or on demand only.</td>
</tr>
<tr>
<td>• Hide &quot;run&quot; associated fields when active is set to false</td>
<td>Certification Schedule</td>
<td>Hides the Run field when Active is set to False.</td>
</tr>
<tr>
<td>• Hide Run When Not Active</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Make table name read only</td>
<td>Certification Schedule</td>
<td>Makes the Table field read-only.</td>
</tr>
<tr>
<td>Hide Table field</td>
<td>Certification Element</td>
<td>Hides the Table field on the certification task form.</td>
</tr>
<tr>
<td>Make percent complete field read only</td>
<td>Certification Instance</td>
<td>Makes the Percent complete field read only when the State is Work in Progress, Closed Complete, Closed Incomplete, or Cancelled.</td>
</tr>
<tr>
<td>Show Assign to fields</td>
<td>Certification Schedule</td>
<td>Shows the Assign To field when the assignment type is User and hides the Assign To field for all other assignment types.</td>
</tr>
<tr>
<td>Show Group field</td>
<td>Certification Schedule</td>
<td>Shows the Assignment Group field when the assignment type is Group and hides the Assignment Group field for all other assignment types.</td>
</tr>
<tr>
<td>Show User field</td>
<td>Certification Schedule</td>
<td>Shows the User field when the assignment type is User.</td>
</tr>
<tr>
<td>Show Assignment Fields</td>
<td>Certification Schedule</td>
<td>Shows the Assign To Empty option when the assignment type is User Field or Group Field.</td>
</tr>
</tbody>
</table>

Business Rules

Data Certification adds the following business rules:

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust dates for cert tasks</td>
<td>Certification Instance</td>
<td>Adjusts dates for tasks belonging to the certification instance when the dates are changed for an active certification.</td>
</tr>
<tr>
<td>Cancel Instance</td>
<td>Certification Instance</td>
<td>Cancels all open certification tasks when an active certification is canceled.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>certification audit instance events</td>
<td>Certification Audit Instance [cert_audit_instance]</td>
<td>Sends an inserted event when an active certification audit instance is created. Sends a completed event when an active certification audit instance is marked as complete or incomplete.</td>
</tr>
<tr>
<td>certification element events</td>
<td>Certification Element [cert_element]</td>
<td>Sends a failed event when an element of a certification is marked as failed.</td>
</tr>
<tr>
<td>certification instance events</td>
<td>Certification Instance [cert_instance]</td>
<td>Sends an inserted event when an instance of a certification is created. Sends a completed event when an instance of a certification is completed.</td>
</tr>
<tr>
<td>Certification Instance Rollup</td>
<td>Certification Task [cert_task]</td>
<td>Updates the Percent complete field on the certification instance record.</td>
</tr>
<tr>
<td>certification task events</td>
<td>Certification Task [cert_task]</td>
<td>Sends an inserted event when a task is inserted. Sends a completed event when a task is deactivated. Sends a canceled event when a task is canceled.</td>
</tr>
<tr>
<td>Certification Task Values</td>
<td>Certification Element [cert_element]</td>
<td>Updates the percent complete of the parent task when a certification element is updated.</td>
</tr>
<tr>
<td>Check Certification Audit Progress</td>
<td>Certification Instance [cert_instance]</td>
<td>Updates the completion status of the audit instance as a whole when a certification that is part of an audit is complete.</td>
</tr>
<tr>
<td>Clean Certification Views</td>
<td>Certification Instance [cert_instance]</td>
<td>Cleans all related records when a certification instance is deleted.</td>
</tr>
<tr>
<td>Copy certification schedule fields</td>
<td>Certification Instance [cert_instance]</td>
<td>Copies changes to the certification schedule to the certification instance.</td>
</tr>
<tr>
<td>Merge Certification Tasks</td>
<td>Certification Task [cert_task]</td>
<td>Merges two tasks together when a task is reassigned and there is another task for the same instance with the new user.</td>
</tr>
<tr>
<td>Prevent delete of Filter with Schedule</td>
<td>Certification Filter [cert_filter]</td>
<td>Prevents the deletion of a filter that is used in a schedule.</td>
</tr>
<tr>
<td>Reassign Notification</td>
<td>Certification Task [cert_task]</td>
<td>Sends out a notification to the new and previous assignees when a task is reassigned.</td>
</tr>
<tr>
<td>Rollup State</td>
<td>Certification Task [cert_task]</td>
<td>Updates all necessary parent items when task state is changed.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update audit reference</td>
<td>Certification Task [cert_task]</td>
<td>Makes Data Certification records compatible with Desired State records. This rule makes sure that the Audit field is correctly completed when a record is inserted using Insert and Stay.</td>
</tr>
<tr>
<td>Update audit result</td>
<td>Certification Element [cert_element]</td>
<td>Makes Data Certification records compatible with Desired State records for reporting purposes. This rule puts certified values in the Desired value column when an audit is Certified. It also puts actual values in the Discrepancy value column when an audit is Failed.</td>
</tr>
<tr>
<td>Update follow_on_task &amp; audit references</td>
<td>Certification Element [cert_element]</td>
<td>Makes Data Certification records compatible with Desired State records for reporting purposes. This rule makes certification tasks compatible with follow-on tasks and displays all tasks, regardless of origin.</td>
</tr>
<tr>
<td>Update next run time</td>
<td>Certification Schedule [cert_schedule]</td>
<td>Updates the Next scheduled run field when a schedule runs Daily, Weekly, Monthly, or Periodically.</td>
</tr>
<tr>
<td>Verify Fields</td>
<td>Certification Schedule [cert_schedule]</td>
<td>Verifies that no field is used in both Display and Certification fields when the fields of a certification schedule are changed.</td>
</tr>
</tbody>
</table>

**Formatter**

Data Certification adds the following formatter:

**Formatter**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certification Task Elements</td>
<td>Enables custom user interface formatting of elements on a certification task. For example, displays the green check mark and red exclamation point to use when certifying an element.</td>
</tr>
</tbody>
</table>
Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.cert_task_activity.fields</td>
<td>System Properties [sys_properties]</td>
<td>Defines which journal field is the task activity field. Default: work_notes</td>
</tr>
</tbody>
</table>

User Roles

Data Certification adds the following user roles:

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>certification_admin</td>
<td>certification</td>
<td>Can:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create and configure certifications</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Override provided answers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Perform certification tasks for certification task owners</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Send certification task notifications to users and owners at any time</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Cancel or delete certifications in any state</td>
</tr>
<tr>
<td>certification_filter_admin</td>
<td>certification</td>
<td>Can create and manage all data certification filters.</td>
</tr>
</tbody>
</table>
| certification             | none           | Can update active or incomplete tasks assigned to them or to groups of which they are a member. Can also update configuration items owned by them or by groups of which they are a member. Receives email notifications when assigned certification tasks.

Events

Data Certification adds the following events. The ServiceNow system uses these events to send email notifications to task owners and managers about changes in certification records.
Email Templates

Data Certification adds the following email templates:

<table>
<thead>
<tr>
<th>Name</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>certification.task.cancelled</td>
<td>A certification task assigned to you/your group as part of the data certification and management process has been canceled.</td>
</tr>
<tr>
<td>certification.task.reminder.inserted</td>
<td>A certification task that has been assigned to you/your group as part of the data certification and management process requires attention.</td>
</tr>
<tr>
<td>certification.task.reminder.outstanding</td>
<td>A certification task that has been assigned to you/your group as part of the data certification and management process requires attention.</td>
</tr>
<tr>
<td>certification.task.reminder.overdue</td>
<td>A certification task that has been assigned to you/your group as part of the data certification and management process is overdue.</td>
</tr>
</tbody>
</table>

Certification schedules

A certification schedule defines the information that requires certification and the frequency of execution. At each time interval specified, or on-demand, the certification schedule generates a set of certification tasks based on set conditions. Use the Preview Certification Tasks related link to preview the certification tasks generated from a certification schedule.
Certification schedule

The minimum requirements for Unix Servers are:
- CPU Speed: 3.0GHz
- RAM: 156GB
- CPU Core Count: 4
Certification tasks

A certification task represents the work of verifying the data associated with a particular record. Task owners are responsible for performing the certification tasks. Tasks have an associated workflow that sends reminders to the task owner and, if necessary, the manager of the owner at regular intervals.
Certification task

Number: TSK0009072
Assigned to: Abel Tuter
Assignment group: 
Complete by: 2018-11-13 15:04:57
State: Closed Complete
Percent complete: 100
Escalation: Normal

Short description: Ensure that all Unix Servers in South America data center meet minimum reqs
Work notes: 
Activities: 0

No activity

Certification data for Certification Task TSK0009072

Go to: CPU speed (MHz)

<table>
<thead>
<tr>
<th>CPU speed (MHz)</th>
<th>RAM (MB)</th>
<th>CPU core count</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.650</td>
<td>8.192</td>
<td></td>
</tr>
<tr>
<td>1.650</td>
<td>8.192</td>
<td></td>
</tr>
<tr>
<td>1.450</td>
<td>8.192</td>
<td></td>
</tr>
</tbody>
</table>
Note: If the message
Record cannot be certified until the instance is finished creating all certification tasks and elements. Reload the page to try again
appears, it signifies that:
• A large amount of data is present in the cmbd_ci and cmdb_ci_server tables.
• Data certification task processing is not complete (Data Certification jobs are still in process).

As directed, reload the page and wait for the processing to complete.

Clean up invalid elements

Use the Clean up invalid elements UI action to query and delete certification elements that reference invalid records. Each certification task has a certification schedule, and each certification schedule has Table and Filter fields. When you use this UI action, it performs the following processing:

1. Collects all available records from Table field in the certification schedule with filters that are available in certification schedule.
2. Collects all certification elements associated with the current certification task.
3. Deletes the certification elements that are no longer available for the data collected in the previous step.
4. After deleting invalid records, it recomputes the certification completion percentage using the following formula:
   \[(1 - (\text{number of certification elements pending} / \text{total no of certification elements associated})) \times 100;\]
5. If there are no certification elements with a Pending status, it marks the associated certification task as Closed, and deactivates it.
6. If there are remaining certification elements with a Pending status, it activates the associated certification task and changes its status to Work in Progress.

Certification elements

Each element of each record being certified is tracked in its own certification element record.

Also tracked are the date and time when the element was certified, comments, and the original and certified values of the field. You can view elements on individual certification tasks.
Certification elements

Certification instances

A certification instance is the collection of certification tasks for one execution of a certification schedule.
Certification instances

Certification audit instances

A certification audit instance is a collection of the certification instances and tasks generated by a single execution of the certification audit definition.
Certification audit instance

Certification audit definition

A certification audit definition is a collection of certification schedules that can be run at once.
Certification audit definition
Data Certification Overview module

The Data Certification Overview module displays various data certification-related reports on the Data Certification Console homepage.

The Overview module is a type of homepage.

The different levels of access are:

Access levels per role

<table>
<thead>
<tr>
<th>Role</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>certification</td>
<td>View (view overview page and refresh reports)</td>
</tr>
<tr>
<td>certification_admin</td>
<td>• View (view overview page and refresh reports)</td>
</tr>
<tr>
<td></td>
<td>• Customize (refresh, add, delete, and rearrange reports)</td>
</tr>
<tr>
<td></td>
<td>View, customize</td>
</tr>
<tr>
<td>admin</td>
<td>• View (view overview page and refresh reports)</td>
</tr>
<tr>
<td></td>
<td>• Customize (refresh, add, delete, and rearrange reports)</td>
</tr>
<tr>
<td></td>
<td>• Edit (can edit reports)</td>
</tr>
</tbody>
</table>

Data Certification Overview Module

The Overview module includes the following reports:

Data Certification Overview Module Description

<table>
<thead>
<tr>
<th>report</th>
<th>Description</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>30/60/90 Day Aging</td>
<td>Groups tasks by the number of days (30, 60, 90, and 90 and over) since the task was opened.</td>
<td>Certification Task</td>
</tr>
<tr>
<td>Certification Instances</td>
<td>Lists all certification instances.</td>
<td>Certification Instance</td>
</tr>
<tr>
<td>Certification Progress Report</td>
<td>Groups tasks by task owner, indicating task progress as a percentage.</td>
<td>Certification Task</td>
</tr>
<tr>
<td>Certification Task Completed Report</td>
<td>Groups tasks by task owner, indicating tasks that are complete.</td>
<td>Certification Task</td>
</tr>
<tr>
<td>Exceptions To Date</td>
<td>Lists all task elements that have comments added and a state of Failed or In Progress.</td>
<td>Certification Element</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
<td>Table</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Functional Roll Up</td>
<td>Lists the managers that have groups with assigned certification tasks. The report is a horizontal bar chart, grouped by status, with each bar representing a manager of an assignment group.</td>
<td>Certification Task</td>
</tr>
<tr>
<td>Hierarchical Roll Up</td>
<td>Shows the managers that have employees with assigned certification tasks (task owners). The report is a horizontal bar chart, grouped by status, with each bar representing a manager of a task owner (identified in the Assigned to field).</td>
<td>Certification Task</td>
</tr>
<tr>
<td>Upcoming Schedules</td>
<td>Lists all schedules that are scheduled to run within the next 30 days.</td>
<td>Certification Schedule</td>
</tr>
</tbody>
</table>

**Use the Data Certification Overview module**

View the status of data certification tasks.

1. Navigate to **Data Certification > Overview**.
2. Click elements within the reports to obtain more information.
   - For example, click any of the colored bars in the **Functional Roll Up** bar chart and detailed information replaces the Data Certification Console screen.
3. Update some fields directly on the overview page.

   For example, in the red box on the image shown, a certification schedule is being updated in the certification instances report.
Data certification overview module
Data Certification planning

Initial planning can make the certification process more successful.

By defining certification schedules and certification audit definitions, users with the certification_admin role establish when certifications are performed, who performs it, and what data must be certified.

Required Roles

Users with the certification_admin role can view filter versions. These users can create, update, and delete filters, if they have the proper access to necessary tables. In the base ServiceNow system, certification_admin users have limited system rights and do not have access to all the tables required for creating a filter. When assigning compliance resources, make sure to grant additional roles to the certification_admin user as needed. For example, this user requires roles that grant access to these tables:

- Company [core_company]
- Cost Center [cmn_cost_center]
- Schedule [cmn_schedule]

Planning Data Certification

Planning the data certification process requires defining:

- The certification schedule defines certification for a particular set of information on a particular table. It also generates certification tasks to perform that certification. One certification task is generated per task owner and a certification instance record groups the tasks.
- The optional certification audit definition groups some certification schedules to be performed together and generates certification audit instances to perform them.

The following questions require answers for each certification schedule:

- What information requires certification?
- When is the due date for certification?
- Who must perform the certification?

Create a certification filter

A filter is a subset of configuration items from any ServiceNow table that is created with a standard condition builder.

An example is a filter that selects all UNIX servers in the Australian data center.

With filters, you can:

- Create multiple versions of a filter and then select the version you want to use.
- Use one filter on multiple certification schedules.
- View the number of records that match your filter as you create the conditions.

Note: Be sure to create certification filters before creating certification schedules.

1. Navigate to Data Certification > Certification Filters.
2. Click New.
3. Fill in the form (see table).
4. Click Submit.

This action saves the filter as version 1.

Certification filter V1
5. To create another filter version, modify the filter conditions and click **Update**.

The system saves the new filter and increments the version number.

**Certification filter V2**

By default, the Certification Filters list shows only the current version of each filter. To see all filter versions, click **All** in the breadcrumbs.
## Certification Filter List

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Table</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unix Servers</td>
<td>Only Unix servers</td>
<td>Server [cmdb_ci_server]</td>
<td>1</td>
</tr>
<tr>
<td>Unix Server in South Africa</td>
<td>Only Unix Servers in South Africa</td>
<td>UNIX Server [cmdb_ci_unix_server]</td>
<td>1</td>
</tr>
<tr>
<td>Oracle Database</td>
<td>Only Oracle Databases</td>
<td>Database [cmdb_ci_database]</td>
<td>1</td>
</tr>
<tr>
<td>Linux Servers</td>
<td>Dell Linux servers</td>
<td>Linux Server [cmdb_ci_linux_server]</td>
<td>2</td>
</tr>
<tr>
<td>Linux Servers</td>
<td>Dell Linux servers</td>
<td>Linux Server [cmdb_ci_linux_server]</td>
<td>1</td>
</tr>
<tr>
<td>IBM Servers</td>
<td>Only IBM Servers</td>
<td>Server [cmdb_ci_server]</td>
<td>1</td>
</tr>
<tr>
<td>Data Center Zones</td>
<td>All data center zones</td>
<td>Data Center Zone [cmdb_ci_zone]</td>
<td>1</td>
</tr>
</tbody>
</table>

Displays all versions
6. To make an inactive filter the current version, open the inactive filter and click **Revert**.

This action creates a new, active version of the filter and makes all previous versions inactive.

7. To delete a single filter version, open that version record and click **Delete**.

8. To delete inactive versions of a filter, click **Delete inactive versions** under Related Links in that filter record.

You cannot delete a filter that is used in a schedule definition. The system displays a warning and the filter is not deleted.

### Certification filter revert

This action creates a new, active version of the filter and makes all previous versions inactive.

### Creating certification filters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Required] Filter name.</td>
</tr>
<tr>
<td>Description</td>
<td>[Optional] Brief description of the filter.</td>
</tr>
<tr>
<td>Number</td>
<td>[Read-only] Automatically assigned filter identification number.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table</td>
<td>Table containing the records to be filtered. Use of the Database View [sys_db_view] table is limited by version.</td>
</tr>
<tr>
<td>Active</td>
<td>Control to make the filter available for use from the Filter field on the Certification Schedule form.</td>
</tr>
<tr>
<td>Version</td>
<td>Current version of this filter. Any significant changes to the filter make the current version inactive. The system copies the updated filter, marks it as active, and increments the version number. The system saves all versions of the filter and makes them available to users. More than one version of a filter can be marked active.</td>
</tr>
<tr>
<td>Filter condition</td>
<td>Field, operator, and value to create the condition. The available options depend on the table selected. You can view the number of records that match the filter by clicking the refresh icon.</td>
</tr>
</tbody>
</table>

**Define a certification schedule**

A certification schedule specifies the fields to display, the fields that require certification, certification task assignments, completion requirements for task owners, frequency of schedule, and detailed instructions.

Use the preview option to see what tasks are created before saving the schedule. If the tasks are not what you want, edit the schedule and preview the tasks again. The system creates certification tasks automatically when it executes a schedule.

To schedule a certification:

1. Navigate to **Data Certification > Schedule Definitions**.
2. Click **New**
3. Fill in the fields (see table).
4. Click **Submit**.

**Defining A Certification Schedule**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A schedule name.</td>
</tr>
<tr>
<td>Filter</td>
<td>A certification filter for this schedule.</td>
</tr>
<tr>
<td>Table</td>
<td>[Read-only] The table holding the records to be certified. To change the table name, select a different Filter or create a new Filter.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Display fields</strong></td>
<td>The fields displayed in the Certification Task list to provide context. These do not require certification themselves. For example, although users are not required to certify the <strong>Name</strong> field of a record, it displays so that users know what record they are certifying.</td>
</tr>
<tr>
<td><strong>Certification fields</strong></td>
<td>The fields to certify on this certification schedule.</td>
</tr>
<tr>
<td><strong>Assignment type</strong></td>
<td>A choice list to select how the certification schedule assigns the certification tasks.</td>
</tr>
<tr>
<td></td>
<td>• <strong>User Field</strong>: Select a user reference field on the table being certified. As an example, select the user named in the <strong>Managed by</strong> field to identify the user who performs the task. This selection displays the <strong>Assign to</strong> and <strong>Assign to empty</strong> fields. If the reference field on the record is empty, the value in the <strong>Assign to empty</strong> field is used.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Specific User</strong>: Select a specific user to perform the tasks. This selection displays the <strong>User</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Group Field</strong>: Select a group reference field on the table being certified. As an example, select the <strong>Support group</strong> field to identify the user who performs the task. This selection displays the <strong>Assign to group</strong> and <strong>Assign to empty</strong> fields. All members of the group from the reference field on the record are assigned to the tasks. If the reference field on the record is empty, the value in the <strong>Assign to empty</strong> field is used.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Specific Group</strong>: Select a specific group to perform the tasks. This selection displays the <strong>Group</strong> field. All members of the named group are assigned to the tasks.</td>
</tr>
<tr>
<td><strong>User</strong></td>
<td>This field appears when:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Assignment type</strong> is <strong>Specific User</strong>. This system assigns this user to all certification tasks for this schedule.</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Assign to empty</strong> field is set to <strong>Create Assigned Task</strong>, and you have selected <strong>User Field</strong> as the assignment type. The system assigns this user to certification tasks containing unassigned records.</td>
</tr>
<tr>
<td></td>
<td>You can only select users with the certification role.</td>
</tr>
<tr>
<td><strong>Assign to group</strong></td>
<td>The group field that defines the group assigned to the certification tasks. This field is available only when the <strong>Assignment type</strong> is <strong>Group Field</strong>.</td>
</tr>
<tr>
<td><strong>Group</strong></td>
<td>The specific group to which certification tasks are assigned for this schedule. This field is available only when the <strong>Assignment type</strong> is <strong>Specific Group</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assign to</td>
<td>The user field that defines which user is assigned to the certification task. This field is available only when the <strong>Assignment type</strong> is <strong>User Field</strong>.</td>
</tr>
</tbody>
</table>
| Assign to empty       | The behavior to use if the field selected in **Assign to** or **Assign to group** is blank on the record being certified. For example, if a task must be assigned to a manager, but no manager is identified, the value in this field determines what happens. This field appears only when the **Assignment type** is **User Field** or **Group Field**. The possible selections are:  
  - **Do Not Create Task**: No task is created when the **Assign to** or **Assign to group** field is empty.  
  - **Create Unassigned Task**: Create a task, but do not assign it to any user or group. The task can be manually assigned later.  
  - **Create Assigned Task**: Create a task and assign it to the user or group specified. If you selected an assignment type of **User Field**, the **User** field is available. If you selected the **Group Field** type, the **Group** field is available.  
  The schedule automatically creates certification tasks for all records that do have "Assign to" populated, regardless of which selection you make for "Assign to empty." |
| Days to complete      | [Required] The number of days that task owners have to complete the certification tasks. When the certification schedule is part of a certification audit definition, the **Days to Complete** audit definition value overrides the value set for the certification schedule.                                                                                                                                    |
| Active                | Check box to activate this certification schedule, generating certification tasks at the scheduled date and time. Clear this check box to hide scheduling fields on the form (except **Last run date**) and not generate certification tasks.                                                                                                                                                 |
| Run                   | How often to run the schedule that generates certification tasks:  
  - Daily  
  - Weekly  
  - Monthly  
  - Periodically  
  - Once  
  - On Demand |
### Preview a certification task

Previewing certification tasks saves any changes to the Certification Schedule form and displays the tasks that are created when you execute the certification schedule.

Previewing tasks is especially useful if you want to test different combinations of options in the **Assignment type**, **Assign to**, and **Assign to empty** fields.

1. Navigate to Data Certification > Schedules > Schedule Definitions.
2. Click a certification schedule Name.
3. In **Related Links**, click **Preview Certification Tasks**.
   The tasks to be created appear at the top of the screen.

![ Certification info message ](image)

**Use a certification schedule notification**

After you define a certification schedule, the system automatically sends notifications to specific users based on the information in the schedule.

The following notifications are sent automatically:

<table>
<thead>
<tr>
<th>Time elapsed to end date</th>
<th>Email template name</th>
<th>Notification message is sent to</th>
</tr>
</thead>
<tbody>
<tr>
<td>0% (when task is created)</td>
<td>certification.task.reminder.inserted</td>
<td>Task owner or assignment group, if specified</td>
</tr>
<tr>
<td>50%</td>
<td>certification.task.reminder.outstanding</td>
<td>Task owner or assignment group, if specified</td>
</tr>
<tr>
<td>75%</td>
<td>certification.task.reminder.outstanding</td>
<td>Task owner, assignment group, if specified, and manager of the task owner, if specified</td>
</tr>
<tr>
<td>95%</td>
<td>certification.task.reminder.outstanding</td>
<td>Task owner, assignment group, if specified, and manager of the task owner, if specified</td>
</tr>
<tr>
<td>100%</td>
<td>certification.task.reminder.overdue</td>
<td>Task owner, assignment group, if specified, and manager of the task owner, if specified</td>
</tr>
</tbody>
</table>

The email templates used in the notifications can be edited, for example, to change the email message text.

**Executing a Certification Schedule**

Executing a certification schedule generates certification tasks based on the schedule.

1. Navigate to **Data Certification > Schedules > Schedule Definitions**.
2. Click a certification schedule **Name**.
3. Click **Execute Now**.

The related lists **Certification Instances** and **Certification Tasks** display the instances or tasks generated by the schedule. The amount of time it takes to generate all certification tasks depends on the size of the table selected and how many fields require certification.

---

**Execute certification schedule**

---

**Define and create a certification audit**

A certification audit is a collection of certification schedules that can be run as a single entity.

Certification audits can be useful when there are multiple certification schedules. After creating a certification audit definition, you can generate a certification audit instance. The certification audit instance is a collection of the certification instances and tasks generated by a single execution of the certification audit definition.

1. Navigate to **Data Certification > Audits > Audit Definitions**.
2. Click **New**.
3. Fill in the fields (see table).
4. Right-click the header bar and select **Save**.
5. In the **Certification Schedules** related list, click **Edit**.
6. In the **Collection** list on the left, select one or more schedules and click **Add**.
7. Click **Save**.

---

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
8. **In Related Links**, click **Create Certification Audit Instance**.

The system generates an audit instance based on the certification schedules selected. All audit instances based on this audit definition are listed in the **Certification Audit Instances** related list.

### Defining and Creating a Certification Audit

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the audit definition.</td>
</tr>
<tr>
<td>Days to Complete</td>
<td>The number of days that task owners have to complete the certification tasks created by this audit definition. Overrides the identical field on the certification schedule.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description of the intended audit.</td>
</tr>
</tbody>
</table>

#### Track a certification audit instance

You can view a list of all certification audit instances at any time.

1. Navigate to **Data Certification > Audits > Audit Instances**.
2. View the **Certification Instances** related list.

The list contains each of the associated instances generated as part of the audit.

### Data certification performance

After the certification process has been planned, certification tasks can be performed according to defined schedules.

Users with the certification role can perform certification tasks. The certification tasks can be tracked as part of certification instances.

### Fulfill certification tasks

After you execute a certification schedule manually or at a scheduled time, the ServiceNow system performs certain actions.

- Creates tasks for any records that meet the filter requirements in the specified table, like tasks from the Configuration Item [cmdb_ci] table.
- Assigns the new tasks to the user or group identified in one of these certification schedule fields:
  - Assign to
  - User
  - Assign to group
  - Group
- Places the new tasks in the **Work in Progress** state.
- Adds the certification schedule **Short description** and **Assigned to** values to the corresponding fields on the certification task record.
- Adds the certification schedule **Days to complete** and **Complete by** date fields to the certification task record, based on when the task is created.
Note: If the certification filter does not match any CIs, the system sets the **State** to **Closed Complete** and the **Percent complete** to **100**.

To view tasks assigned to you, navigate to **Data Certification > Tasks > My Tasks**.

The following information is tracked on the certification task record:

**Certification task record**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>An identification number for the certification task.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user responsible for certifying the data.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group responsible for certifying the data.</td>
</tr>
<tr>
<td>Complete by</td>
<td>[Read-only] A date field containing a deadline for the task. This field is automatically filled in based on the Days to Complete field on the certification schedule.</td>
</tr>
<tr>
<td>State</td>
<td>[Read-only] The current state of the certification task. The selections are: Work in Progress, Closed Incomplete, Closed Complete, and Cancelled.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>The task progress as a percentage. This field is read-only when a task is in a Closed Incomplete, Closed Complete, or Cancelled state.</td>
</tr>
<tr>
<td>Escalation</td>
<td>[Read-only] The escalation level of the task. When 0–49% of the time to Complete By has elapsed, this field is set to Normal. At 50%, this field changes to Moderate and an email reminder is sent to the task owner. At 75%, this field changes to High and an email reminder are sent to the task owner and the manager of the task owner. At 95%, this field remains set to High, but a second email reminder is sent to the task owner and manager.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A short description of the task. This field is automatically filled in with the text from the certification schedule of the Task description field.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about work performed on the certification.</td>
</tr>
</tbody>
</table>

**Export the certification list**

Users with the certification_admin role can export the certifications list and save the list in Excel, CSV, XML, or PDF format. This list is useful when you have a long list of certification elements or if many different users are assigned to certify elements on a single certification schedule.

For general information and common export steps, see [List export](#).

1. Navigate to **Data Certification > Tasks > All Tasks**
2. Open a task.
3. Open any column context menu in the certification data list and complete the export.
Certify an element

The Certification Task form contains a list of all elements to be certified.

**Note:** After you certify all the elements in a task, no elements can be reverted.

1. Navigate to **Data Certification** > **Tasks** > **My Tasks**.
2. Open a certification task with a **State** of **Work in Progress**.
3. In the upper right corner of the list, select records that require certification for this task or all records that are part of this certification task.
4. Select the check box beside a certification element.
5. In **Optional comment for checked elements**, above the list, enter information that would be useful to others.

![Certification list](image)

6. **Do:**
   - Click the green check mark to certify the element.
   - Click the red exclamation point to fail the element.

7. To see the certified or failed element, set the view to **Show All Records**. A green check mark or red exclamation mark appears beside the element.

8. Point to an icon to see any certification comments.

9. Ensure that all elements have the correct certification, either accepted or rejected.
   - After you certify all elements, no elements can be reverted. When all elements of a certification task are certified or rejected, the task **State** changes to **Closed Complete**.

**View an audit result**

View audit results after you certify the elements.

1. **Navigate to Data Certification > Schedules > Audit Results.**
   - The list of data certification audit results appears, grouped by certification instances. Certified configuration items show the **Original value** only. Failed CIs contain the **Certified value** and the **Original value**.
2. Click the links in the list to open any of the related records.

Data cert audit results

Reset certifications
You cannot reset any element after all elements are certified.

- To reset individual certifications, right-click the element in the certification list and select **Revert Certification**.
- To reset the entire task to its starting point, click the **Reset all Certifications to Pending** related link.

Track a task with a certification instance
The Certification Tasks related list on the certification instance record provides information about associated tasks.

The **State** field on the certification instance record is read-only and is based on the cumulative states of the certification tasks associated with the instance. The **Percent complete** column allows users with the certification_admin role to track task progress quickly. For more information, see Track Certification Tasks.
To track a certification instance:

1. Navigate to **Data Certification > Schedules > Instances**.
2. Click a certification instance **Number**.
3. View and edit the following fields as necessary.

### Certification instance

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Read-only] Automatically generated identification number for the instance.</td>
</tr>
<tr>
<td>Certification Schedule</td>
<td>The certification schedule used to create the certification instance.</td>
</tr>
<tr>
<td>State</td>
<td>[Read-only] Current state of the certification instance: Work in Progress, Complete, Closed Incomplete, or Cancelled. For more information, see Track Certification Tasks.</td>
</tr>
<tr>
<td>Created</td>
<td>[Read-only] Date and time the certification instance was created. Date is filled in automatically when the Execute Now button clicks the associated certification schedule.</td>
</tr>
<tr>
<td>Complete by</td>
<td>[Required] Date and time when the certification instance must be completed. The system updates this field when it executes the schedule, using the deadline specified on the instance. All certification tasks associated with the certification instance must be marked Complete, Closed Incomplete, or Cancelled before the instance is complete.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Percentage of the instance that has reached the Closed Complete state. This field is automatically filled in based on the Percent Complete fields on the associated certification tasks.</td>
</tr>
<tr>
<td>Task Description</td>
<td>Information about the certification instance. This field automatically displays the text from the Task description field of the associated certification schedule.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Field for providing instructions to the user or group performing the certification. This field is automatically filled in with information from the Instructions field on the associated certification schedule.</td>
</tr>
</tbody>
</table>

### Cancel a certification instance

Users with the certification_admin role can cancel a certification instance.

The instance must have a **State** of **Work in Progress**. Canceling a certification instance:

- Changes the certification instance **State** to **Cancelled**.
- Changes all associated **Work in Progress** certification tasks to **Cancelled**.
To cancel a certification instance:
1. Navigate to Data Certification > Schedules > Instances.
2. Click a certification instance Number.
3. Click Cancel.

**Track a certification task**

Use the certification task state to track the progress of a task.

The available task states are **Work in Progress**, **Closed Complete**, **Closed Incomplete**, and **Cancelled**.

When the state of a certification task changes, the certification instance state also changes in the following cases:

- If any certification task is in **Work in Progress** state, the certification instance is placed in **Work in Progress** state.
- If all certification tasks are in **Cancelled** state, the certification instance is placed in **Cancelled** state.
- If all certification tasks are in **Cancelled** or **Closed Complete** state, the instance is placed in **Closed Complete** state. For example, if three certification tasks are **Cancelled**, and one task is **Closed Complete**, the instance state is changed to **Closed Complete**.
- When one certification task is **Closed Incomplete** and the remainder of the tasks are **Cancelled** or **Closed Complete**, the instance is placed in **Closed Incomplete**.

To view the state of certification tasks:
1. Navigate to Data Certification > Tasks and select My Tasks or All Tasks.
2. View the State column for each task.

**Escalate a certification task**

Users with the certification_admin role can escalate a task in the Work in Progress state. To escalate a task, the task owner identified in the Assigned to field on the task record must have an associated manager.

Personalize the User form to see the Manager field.

Escalating a task:

- Sends an email message to the task owner and the manager of the task owner stating that the task has been escalated.
- Sets the manager as the new task owner.

The event that triggers the escalation is named cert_task.escalate and the email notification is named Escalation Notification. To edit the text of the email message that is sent, edit the Escalation Notification email notification directly.

For more information, see Email notifications.

To escalate a certification task from the Certification Task form:
1. Navigate to Data Certification > Tasks > All Tasks.
2. Click a certification task Number.
3. Click Escalate. If the Escalate button is not available, the user in the Assigned to field does not have an associated Manager.
Escalate a certification task from the certification task list

Escalate a certification task to notify the manager of the current task owner.

To escalate a task, the task owner identified in the Assigned to field on the task record must have an associated manager.

1. Navigate to Data Certification > Tasks > All Tasks.
2. Select the check box to the left of a certification task Number. Multiple check boxes can be selected.
3. From the Actions on Selected Rows menu below the list, select Escalate. If the Escalate button is not available, the user in the Assigned to field does not have an associated Manager. Select multiple tasks from the list. The menu option shows how many tasks are not eligible for escalation, such as Escalate (4 of 6).

Reassign a certification task

If you have the certification_admin role, you can reassign any certification task in the Work in Progress state. Tasks in Closed Complete, Closed Incomplete, or Cancelled state cannot be reassigned. When a task is reassigned, the current task owner and the new task owner are sent a message.

Role required: certification_admin

The event associated with the reassignment is named cert_task.reassign and the email notification is named Certification Task Reassignment. To edit the text of the email message that is sent, edit the Certification Task Reassignment email notification directly.

For more information, see Email notifications.

To reassign a certification task:

1. Navigate to Data Certification > Tasks > All Tasks.
2. Click a certification task Number.
3. Enter a new name in the Assigned to field.

Send certification task reminders

The Certification Task Escalations workflow sends automatic email reminders.

The Certification Task Escalations workflow sends automatic email reminders to the:

- Certification task owner.
- Assignment group, if the assignment group was specified on the Certification Task form.
- Manager of the certification task owner, if necessary and if a manager was specified on the User form.

The reminders are based on the Complete by field on the certification task record. If the Complete by date is changed, the reminder schedule automatically adjusts to reflect the new date.

Certification task reminders

<table>
<thead>
<tr>
<th>Time elapsed to end date</th>
<th>Email reminder is sent to</th>
<th>Escalate field on task record reads</th>
</tr>
</thead>
<tbody>
<tr>
<td>50%</td>
<td>task owner and assignment group (if specified)</td>
<td>Moderate</td>
</tr>
<tr>
<td>75%</td>
<td>task owner, assignment group, and manager of the task owner</td>
<td>High</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Time elapsed to end date</th>
<th>Email reminder is sent to</th>
<th>Escalate field on task record reads</th>
</tr>
</thead>
<tbody>
<tr>
<td>95%</td>
<td>task owner, assignment group, and manager of the task owner</td>
<td>High</td>
</tr>
<tr>
<td>100%</td>
<td>task owner, assignment group, and manager of the task owner</td>
<td>High</td>
</tr>
</tbody>
</table>

To set reminders for different or more intervals, edit the workflow Certification Task Escalations. In addition to the email reminders sent automatically, users with the certification_admin role can send email reminders manually at any time.

### Send an email reminder from the certification task form

How to manually send email reminders from the Certification Task form.

1. Navigate to Data Certification > Tasks > All Tasks.
2. Click a certification task Number.
3. Right-click the header bar and select Resend email notifications.

### Send an email reminder from the certification task list

How to manually send email reminders from the Certification Task list.

1. Navigate to Data Certification > Tasks > All Tasks.
2. Select the check box to the left of a certification task Number. Multiple check boxes can be selected.
3. From the Actions on Selected Rows menu below the list, select Resend email notifications. Select multiple tasks from the list. The menu option shows how many notifications are outstanding and how many were sent, such as Resend email notifications (15 of 18).

### Mark a certification task as closed incomplete

Mark a task as closed incomplete if, for example, only some of the elements can be certified.

The following users can mark a task as closed incomplete:

- Users with the certification_admin role.
- User identified in the Assigned to field on the certification task record.

To mark a task as closed incomplete:

1. Navigate to Data Certification > Tasks and select All Tasks, or My Tasks.
2. Click a certification task Number.
3. In Work Notes, enter information about why the task could not be completed.
4. Click **Close Incomplete**.

If at least one task on a certification instance is marked **Closed Incomplete**, the **Completed** date and **Percent complete** fields on the certification instance record are not updated. A user with the certification_admin role can:

- Complete the incomplete task or tasks.
- Cancel the incomplete task or tasks.

When all tasks on the certification instance are **Closed Complete** or **Cancelled**:

- The system sets the **Completed** date field on the certification instance record to the current date and time.
- The **Percent complete** field on the certification instance record is set to 100 percent.

### Certification tasks cancellation

Users with the certification_admin role can cancel a certification task in the Work in Progress or Closed Incomplete state.

When a certification task is cancelled, a notification email is sent to the task owner or assignment group assigned to the task. The task owner or assignment group manager is not notified.

#### Cancel an individual task

Cancel a particular data certification tasks in the Work in Progress state.

1. Navigate to **Data Certification > Tasks > All Tasks**.
2. Find a task with a **State** of **Work in Progress**.
3. Click the task **Number**.
4. Click **Cancel**.

#### Cancel all tasks in an instance

Cancel data certification tasks in the Work in Progress state.

1. Navigate to **Data Certification > Schedules > Instances**.
2. Find an instance with a **State** of **Work in Progress**.
3. Click the instance **Number**.
4. Click **Cancel**.

All tasks in the instance with a state of **Work in Progress** are cancelled. The task owner or assignment group is notified.

The email template used for the notification is named **certification.task.cancelled**. The email templates can be edited to change the email message text, for example.

### Domain separation and Data Certification

This is an overview of domain separation and Data Certification processing. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.
Overview

Support: Data only

Domain separation in this application is supported at the Data only level, meaning it supports the data security model of separating visibility of data from one domain to another. To learn more, see Application support for domain separation.

Decision Tables

Use decision tables to help you resolve a complex decision that depends on multiple factors.

Use decisions tables to help you reach outcomes that depend on multiple factors. In these tables, each factor is a decision input. For example, if you are trying to make a decision about car insurance coverage, your inputs might include the location where the insured person lives, the age and accident history of the insured person, the car make, the car model, and the car year. This logic can save time and present a more organized, readable format than using a script. Decision tables provide a single point where you can create, view, and modify decisions.

To interact with Decision Tables in script, use the Decision Table API.

Components of a decision

Decision Table [sys_decision] records

Decision table records represent a single decision. In this record, you specify which table you want to use for your answers. This record also contains related lists where you can create your decision inputs and decisions.

Decision inputs [sys_decision_input] records

Decision input records represent your inputs that are used to obtain answers in a decision. These inputs can include a variety of types, including strings, references, true/false inputs, and dates. Each decision input has a specified input type and can be assigned a default value.

Decision [sys_decision_question] records

Each decision record represents a decision that is based on your inputs. Use the condition builder on the decision record form to create a condition that is based on the inputs for this decision. Then, you can select an answer record for this decision. The answer record can be any record from the table that you have defined in the Decision Table record. You can select the same answer record for more than one decision.

Answer records

Answer records represent answers that are reached using different decision input values. Answers records can be records on any table, but you need to choose the table when creating your Decision Table record. You could, for example, use the sys_choice table to use existing choice records. From the example about insurance coverage, you could create a table where each record contains details about the levels of insurance coverage.

Use a decision table to determine a discount rate

The following example shows a decision table. In this example, you see two inputs, Units Ordered and Cash on Delivery. The two possible answers, Yes and No, are reached depending on the answers to the two questions. For example, a customer would qualify for a silver discount when ordering more than 50 items or paying in cash, and get a gold discount if doing both.
Sample decision table — discount rates

<table>
<thead>
<tr>
<th>Decision inputs</th>
<th>Decision input entries</th>
</tr>
</thead>
<tbody>
<tr>
<td>More than 50 units ordered</td>
<td>No</td>
</tr>
<tr>
<td>Cash on delivery</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Decision Answers

<table>
<thead>
<tr>
<th>Discount</th>
<th>Silver Discount</th>
<th>Bronze discount</th>
<th>Gold discount</th>
<th>Silver discount</th>
</tr>
</thead>
</table>

Create a decision table to resolve complex decisions

Create a decision table to help you resolve a complex decision that depends on multiple factors.

Role required: decision_table_admin

1. Create or select a table to use for your decision answer records. You will associate an answer record to each decision on your decision table in later steps. This answer record is returned when that decision is reached based on your inputs. For information on creating a table, see Create a table.

2. Ensure that one field on the table that you use for your decision records has been set as the display value. This field is used as a label when you display decision answers in Flow Designer. You can use an existing table or create a new table to use for your decision records.

3. Create a record on this table to each answer in your decision.
   If you have modified an existing table, you may need to customize the form to show the new fields that you have added.

4. Create a decision table record.
   a) Navigate to Decision Tables > Decision Tables, and click New.
   b) On the form, fill in the fields.

   Decision Table form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive label for this decision.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of this decision. This field defaults to the current scope.</td>
</tr>
<tr>
<td>Answer table</td>
<td>Table that this decision uses for answer records. Select the table that you created in the previous steps.</td>
</tr>
<tr>
<td>Accessible From</td>
<td>Option to limit the availability of this decision to the current scope. Select All application scopes or This application scope only.</td>
</tr>
</tbody>
</table>

   c) Right-click the form header and select Save.
      The form refreshes with the Decision Inputs and Decisions related lists.
5. Create decision input records.
   a) In the Decision Inputs related list, click New.
   b) On the decision input form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the decision that is associated to this decision input. This field is automatically populated.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of this decision input. This field defaults to the current scope.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of data that is used for this input. When you use this decision in a flow, you can only use data pills that match this type.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate this input. This field is selected by default.</td>
</tr>
<tr>
<td>Label</td>
<td>Descriptive label for this input.</td>
</tr>
<tr>
<td>Read only</td>
<td>Check box to make this decision input read-only.</td>
</tr>
<tr>
<td>Column name</td>
<td>Column name for this input. This field is automatically populated when you give the Label field a value.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box to make this decision input mandatory.</td>
</tr>
<tr>
<td>Display</td>
<td>Check box to indicates that this decision input is the display value for reference fields.</td>
</tr>
<tr>
<td>Choice</td>
<td>Select a method for users to see a list of suggested values:</td>
</tr>
<tr>
<td></td>
<td>• List menu without -- None --</td>
</tr>
<tr>
<td></td>
<td>• List menu with -- None --</td>
</tr>
<tr>
<td></td>
<td>• Suggestion field type</td>
</tr>
<tr>
<td></td>
<td>If a choice is used, define your choices in the Choices related list at the bottom of the form.</td>
</tr>
<tr>
<td>Default Value</td>
<td>Default value for this input.</td>
</tr>
</tbody>
</table>

c) Click Submit.
   Your changes are saved and the decision table record reopens.

6. Create decision records.
   a) In the Decisions related list, click New.
   b) On the Decision form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Descriptive label for this decision table.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Application scope of this decision. This field defaults to the current scope.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the flow evaluates decisions. The order can be important in flows that use the First decision that matches option and ends after the first match is found.</td>
</tr>
<tr>
<td>Answer</td>
<td>Answer that is used when the conditions in this decision are met.</td>
</tr>
<tr>
<td>Default Answer</td>
<td>Check box to enable this decision as the default for your decision table.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that are needed to reach this decision. The fields available for your condition are the Decision inputs that are associated with this decision table.</td>
</tr>
</tbody>
</table>

- **c)** Click **Submit**.
  
  Your changes are saved and the decision table record reopens.

With Flow Designer, you can add your decision to the **Make a decision** flow logic. For more information about the **Make a decision** flow logic, see **Make a decision flow logic**.

### Decision table properties

Use decision table properties to set limits on the maximum number of allowed inputs and questions for decision records.

These properties are available for decision tables.

**Note**: To open the System Properties [sys_properties] table, enter `sys_properties.list` in the navigation filter.

#### Properties for decision tables

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.decision_table.max_inputs</td>
<td>Maximum number of decision inputs that can be defined on a model (sys_decision) record.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: Empty. There are no limits on inputs when this property is left empty.</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>com.glide.decision_table.max_questions</td>
<td>Maximum number of decision questions that can be defined on a decision table (sys_decision) record.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: Empty. There are no limits on inputs when this property is left empty.</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table</td>
</tr>
</tbody>
</table>

### E-signature

Sign electronic documents from any desktop or mobile device with e-signature. E-signature is a scoped application that enables users to sign managed documents or knowledge articles with their typed or drawn e-signature, credentials, or as an acknowledgment.

#### Role assignment

Before you begin using e-signature, you must assign the e-signature roles to the appropriate roles, groups, or users in your application. See Components installed with e-signature for more information.

#### How to use e-signature templates

Users with the e-signature administrator [sn_esign.admin] or manager [sn_esign.config_manager] role can create e-signature templates. Each e-signature template pairs a document type to sign (managed document or knowledge article) with a signature type (signature, credential, or acknowledgment). For example, you could create an e-signature template for a non-disclosure agreement that requires a typed or drawn signature.

- Configure an e-signature template

You can then use the e-signature template in task forms to request electronic signatures from users. In the HR Service Delivery application, for example, you can add HR tasks to HR cases or configure HR task templates to request electronic signatures per the selected e-signature template. See E-signature for HR for HR-specific examples.

#### Activation information

To use e-signature in your application, you must activate e-signature. For information on what components are installed with the feature, see Components installed with e-signature.

#### Activate e-signature

You can activate the e-signature plugin (com.snc.esign) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

E-signature activates these related plugins if they are not already active.
## Plugins for E-signature

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow document viewer [com.snc.documentviewer]</td>
<td>Document viewer is a platform feature that will enable users to view enterprise class documents inline within the platform attachment instead of downloading it to the local device and then opening the documents with a locally installed viewer.</td>
</tr>
<tr>
<td>Managed documents [com.snc.document_management]</td>
<td>Managed Documents application. To enable the ability to publish to the knowledge base, activate the knowledge document plugin.</td>
</tr>
<tr>
<td>Signature pad [com.snc.signaturepad]</td>
<td>Provides a tool to allow a digital signature in a .pdf document. The Human Resources application uses this with various documents.</td>
</tr>
</tbody>
</table>

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

## Components installed with e-signature

Several types of components are installed with activation of e-signature, including tables and user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

## Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-signature administrator [sn_esign.admin]</td>
<td>Can manage the e-signature module.</td>
<td>• sn_esign.config_manager</td>
</tr>
<tr>
<td>E-signature manager [sn_esign.config_manager]</td>
<td>Can manage the e-signature configurations.</td>
<td>• None</td>
</tr>
</tbody>
</table>

You can assign these roles to the appropriate roles, groups, or users in your application.

- To assign a role to another role, see Add a role to an existing role.
• To assign a role to a group, see Assign a role to a group.
• To assign a role to a user, see Assign a role to a user.

For further information on user administration and how to manage users, see User administration.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Signature Configuration [sn_esign_configuration]</td>
<td>E-signature configuration table.</td>
</tr>
<tr>
<td>E-Signature Acknowledgement [sn_esign_acknowledgement]</td>
<td>E-signature acknowledgment table.</td>
</tr>
</tbody>
</table>

For further information on table administration and how to manage data, see Table administration.

Configure an e-signature template

Create or modify an e-signature template to define an electronic document and signature configuration for use in task forms. Each template is associated with a document type such as a managed document or knowledge article, and you can configure the template so that the signatory is required to sign the document with their typed or drawn signature, credentials, or as an acknowledgment.

Role required: sn_esign.admin or sn_esign.config_manager

1. Navigate to E-signature > E-signature template.
2. Click New or open a record.
3. Fill in the fields on the form.

E-signature template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the e-signature template.</td>
</tr>
<tr>
<td>Task table</td>
<td>Task table that the e-signature template is associated with.</td>
</tr>
<tr>
<td>Document type</td>
<td>Document type of the e-signature template. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>(HR Service Delivery only) An HR document template is the document type for signing.</td>
</tr>
</tbody>
</table>

**Note:**
- Make sure that the Task table field is set to HR Task [sn_hr_core_task].
- The HR document template that the signatory will sign is selected on the HR case form. See Select an HR document template for an e-signature task for more information.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge article</td>
<td>A knowledge article is the document type for signing. In the <strong>Knowledge article</strong> field, select the knowledge article that the signatory will sign.</td>
</tr>
<tr>
<td>Managed document</td>
<td>A managed document is the document type for signing. In the <strong>Managed document</strong> field, select the managed document that the signatory will sign.</td>
</tr>
<tr>
<td>Signature type</td>
<td>Signature type of the e-signature template. Select one of the following:</td>
</tr>
<tr>
<td>Acknowledgment</td>
<td>The signatory acknowledges the document by accepting and completing the task.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option is not available for HR document templates.</td>
</tr>
<tr>
<td>Credential</td>
<td>The signatory signs the document with their credentials.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option is not available for HR document templates.</td>
</tr>
<tr>
<td>Signature</td>
<td>The signatory signs the document with their typed or drawn signature.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Acknowledgment text</th>
<th>Adds a check box with accompanying acknowledgment text that the user must select before the signing is completed. This option can be used with any signature type.</th>
</tr>
</thead>
</table>

**Note:** Acknowledgment text is limited to 1,000 characters.

---

The following GIF shows an example of an HR agent creating an e-signature template for an intellectual property agreement.

4. **Click Submit or Update.**

You can use the e-signature template in task forms to request electronic signatures from users.

The following GIF shows an example of an HR agent creating an e-signature task for an employee, Eva Seahorn, as part of an HR case.
The following GIF shows an example of the employee, Eva Seahorn, then completing the e-signature to-do in the Employee Service Center.
Employee Service Center
Welcome to the single destination for all employee needs
Edge Encryption

ServiceNow® Edge Encryption™ encrypts sensitive data on your company premises before sending it over the Internet to your ServiceNow instance (encrypted in flight), where it remains encrypted at rest.

### Explore
- Understanding Edge Encryption
- Edge Encryption components
- Encryption configurations and patterns
- Domain separation in Edge Encryption

### Set up
- Planning for Edge Encryption
- Edge Encryption system requirements
- Edge Encryption installation
- Edge Encryption upgrades

### Administer
- Key management
- Encrypt fields using encryption configurations
- Encrypt attachments using standard encryption
- Tokenize strings using encryption patterns

### Use
- Define a custom encryption rule
- Schedule an encryption job
- Repair or recover order-preserving encrypted data

### Integrate
- Edge Encryption ODBC driver integration
- Edge Encryption MID Server integration

### Troubleshoot and get help
- Ask or answer questions in the Edge Encryption forum
- Edge Encryption diagnostics and performance
- Search the HI knowledge base for known error articles
- Contact ServiceNow Technical Support

### Understanding Edge Encryption

Edge Encryption is a network encryption system that resides on your network and that encrypts and decrypts sensitive data as it travels between your data center and the ServiceNow cloud.

### What is Edge Encryption

The Edge Encryption proxy server is a network encryption application that, through encryption in motion, encrypts data within your network before it is sent over the Internet to your instance, where it remains encrypted at rest. When requested, the encrypted data is sent back to the Edge Encryption proxy server, which in turn decrypts your data before serving it to your web browser.

### Who uses Edge Encryption

Only a user logged into the instance through a proxy server on your network can view encrypted data in clear text. Likewise, only a security_admin user logged in to an instance through a proxy server in your network can configure and administer Edge Encryption.

Because the proxy server resides in your network, you own and manage the encryption keys, and they are never sent to the instance. As a result, ServiceNow never shows sensitive data in clear text.
Encryption and tokenization

Edge Encryption supports both encryption (through encryption configurations) and tokenization (through encryption patterns) as a means of protecting your sensitive information.

Encryption configurations

You can encrypt individual fields using encryption configurations. Edge Encryption supports AES 128-bit and AES 256-bit encryption keys. Edge Encryption supports standard, equality-preserving, and order-preserving encryption types.

In addition to attachments, you can encrypt the following field types:

- String
- Date
- Date/Time
- Journal
- Journal Input
- URL

If a Journal field marked for encryption is added to the activity stream, all user input to the field is encrypted in the activity stream.

Note: Multi-byte characters within supported field types can be encrypted.

Encryption patterns

You can use encryption patterns to tokenize strings that match regular patterns such as social security and credit card numbers. While encryption configurations should be the primary method of encryption, use encryption patterns as a supplement to secure sensitive information found outside of encrypted fields.

Note: The Edge Encryption proxy server requires a MySQL database in your network only if using order preserving encryption or encryption patterns. Clear text values are stored in the proxy database in your network. For this reason, it is critical that you secure and regularly back up your proxy database. For recommendations, see Edge Encryption components.
Edge Encryption on the Now Platform

Edge Encryption acts as a gateway between your browser and your ServiceNow instance. Traffic from your browser passes through the gateway on its way to the ServiceNow instance. The gateway, in turn, is configured to encrypt outbound data that is marked for encryption. Inbound traffic is decrypted through the gateway, and the end user sees clear text in the browser. The advantage of this implementation from a security control perspective is that the encryption and key management are handled externally from ServiceNow.

What to know before you begin

Because encryption and tokenization change the nature of your data, Edge Encryption can affect other instance processes. Before using Edge Encryption, carefully consider the impact on your instance.

Because the proxy server is installed and maintained in your network, Edge Encryption requires network administration and management. Review the network requirements to ensure a smooth implementation.
Review the following topics to understand the impact of Edge Encryption on your instance:

- Planning for Edge Encryption
- Edge Encryption system requirements
- Sizing your Edge Encryption environment
- Calculate the order-preserving and tokenization database size
- Edge Encryption limitations
- Key management

**Edge Encryption components**

Edge Encryption is comprised of the Edge Encryption proxy server that runs on a server in your network, and the Edge Encryption plugin that must be installed on your ServiceNow instance. If using order-preserving encryption types or encryption patterns, a proxy database must also be installed in your network.

**Proxy application**

When going through the Edge Encryption proxy server, the Edge Encryption plugin allows you to specify which fields, patterns, and attachments should be encrypted. You can also manage encryption rules to encrypt specific requests and schedule mass encryption jobs.

**Proxy server**

The Edge Encryption proxy server uses encryption rules to identify in an HTTP request what, if anything, needs to be encrypted and encrypts it before forwarding the request to the instance. For decryption, the Edge Encryption proxy server looks at the HTTP responses for any encrypted data and decrypts it before sending the response back to the client. In order for this to happen, all HTTP requests and responses must go through the Edge Encryption proxy server. This includes any requests originating from a browser, as well as any SOAP or REST requests.

**Proxy database**

If using order preserving encryption or encryption patterns, your proxy servers rely on a MySQL database located in your network. All proxy servers in your network must use the same database.

The proxy database contains these tables.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>db_id</td>
<td>Unique database ID</td>
</tr>
<tr>
<td>edge_token_map</td>
<td>Encryption pattern data</td>
</tr>
<tr>
<td>token_map</td>
<td>Order-preserving encryption data</td>
</tr>
</tbody>
</table>

**Backing up your proxy database**
Because encryption patterns rely on tokenization, clear text values are stored in your proxy database. If the database is lost, clear text values cannot be restored. It is critical that you maintain regular backups. To avoid data loss, back up your proxy database according to ServiceNow recommendations.

- Back up your database every 24 hours.
- Retain MySQL database binary log files for at least two days. After a backup has been restored, use the binary log to regenerate any data lost since the most recent backup. Refer to MySQL database backup best practices for your database version.

**Edge Encryption clients**

Edge Encryption uses three clients to inform the instance that the proxy is running, to synchronize requests between the proxy and the instance, and to forward all end user requests to the instance after any potential encryption.

<table>
<thead>
<tr>
<th>Client</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>heartbeat/keepalive client</td>
<td>In charge of sending a request to the ServiceNow instance every 5 seconds to let the instance know that this proxy is up and running. The requests drive the last_response_on field on the Edge proxy table, and as a consequence drive the state of the proxy. If your system has issues sending the requests, or if the request or request processing is delayed, the instance may mark the proxy as unresponsive, even if the other clients (including the one for user traffic) are up and running. This client also controls the online status of the proxy on the instance. The <code>edgeencryption.proxy.keepalive.interval</code> property controls the polling rate for this client. The default is 5 (seconds).</td>
</tr>
<tr>
<td>polling/sync client</td>
<td>In charge of various requests the proxy sends to the instance to synchronize on the Edge Encryption configuration (for example, which table, column, or attachment to encrypt, keys, jobs, rules, and tokenization patterns). The <code>edgeencryption.config.poll.interval</code> property controls the polling rate for this client. <strong>Warning:</strong> Do not change this setting. Changing the default setting of the proxy poll interval may result in synchronization delays when updating Edge Encryption settings on the instance.</td>
</tr>
<tr>
<td>default/user traffic client</td>
<td>For everything else, this client handles all end user requests and forwards them to the ServiceNow instance after any potential encryption. This client also handles responses from the instance, forwarding them to the end user after any potential decryption.</td>
</tr>
</tbody>
</table>

**Key management**

You are responsible for providing and managing the encryption keys used by Edge Encryption.
When obtaining and creating encryption keys to support the encryption types used by Edge Encryption, consider the following:

- Whether to use AES 128-bit or AES 256-bit. You must define a default AES 128-bit encryption key, even if it is not used.
- Whether to use file system, Java KeyStore, or Enterprise Key Management (EKM).
- When to rotate encryption keys.
- When and if to use a mass encryption job to re-encrypt data using the new key.

Before removing a key from the proxy configuration files and the keystore, it is critical that you decrypt all data on the instance that uses the key. You can do this by adding a new encryption key and scheduling a mass key rotation job.

**Keystores**

Edge Encryption supports the following types of key storage.

**File store**

Keys are stored in a file in a file system that is accessible by the Edge Encryption proxy. Encryption keys stored in a file are not encrypted, so it is your responsibility to protect these files.

**Java KeyStore**

Keys are stored in Java’s JCEKS KeyStore. A Java KeyStore is protected by a password, so it is more secure than storing keys in a file in the file store. A single Java KeyStore can store multiple keys, and the keys are identified by a key alias, making it easier to manage multiple keys.

**Enterprise Key Management (EKM)**

Keys are stored and retrieved with the SafeNet KeySecure or Unbound Technology key management systems.

The Edge Encryption proxy ships with the Java JCEKS KeyStore file named `keystore.jceks` in the `keystore` directory. This keystore file contains the ServiceNow public key used to validate encryption rules signed by ServiceNow.

**Note:** If using a keystore other than the base system Java JCEKS KeyStore, you must import the ServiceNow public key into your keystore. The public key alias is `servicenow`.

In addition to the encryption keys, the Java JCEKS KeyStore is used to store the RSA key pair for digitally signing the encryption configuration and encryption rules that are stored in the instance, and the digital certificate that the Edge Encryption proxy uses to establish a secure connection with the browsers and any other clients.

**SafeNet key versioning**

Use SafeNet key versioning to simplify changing keys. Instead of creating a new alias for every new key, SafeNet key versioning keeps the same alias and increments the version.

You must set up key versioning in SafeNet before you can configure SafeNet key versioning on the Edge proxy server.

**Note:** Edge proxies installed before the London release support SafeNet keys, but do not support SafeNet key versioning. If you mistakenly use a versioned key on a Kingston or earlier proxy, when you upgrade to a London or later release, the London or later proxy detects this problem, and to prevent potential data loss the proxy does not start.
You must first schedule a mass key rotation job or a single key rotation job to replace the old SafeNet versioned key with a non-versioned key, and then create a new SafeNet versioned key, if needed. This new versioned key is safe to use with the London or later proxy, and you can restart the proxy.

Encryption key configuration

If using SafeNet versioned keys, the Change Default Keys section of the Encryption Key Configuration form includes new fields for the **Key version** of the default 128-bit and 256-bit keys. **Key version** fields are grayed out and cannot be edited.

For procedures, see Configure encryption keys on the instance.

Versioned keys

If using SafeNet versioned keys, when you navigate to **Edge Encryption Configuration > Encryption Key Configuration > All Keys**, versioned keys include the **Key version**.
A version number does not appear for the initial entries you make in the Change Default Keys section of the Encryption Key Configuration form. When the proxy server requests a key from SafeNet, the system adds a new line for the alias and adds the **Key version**.

In the above example, **AES128key** is listed three times:

- The first listing, with no **Key version** indicated, is the initial entry.
- The second listing, with 1 in the **Key version** column, is the first version of the key returned from SafeNet.
- The third listing, with 2 in the **Key version** column, is the second version of the key returned from SafeNet.
- As other versions of the key are returned from SafeNet, new lines are added to record the **Key version** now in use.

### Encryption configurations and patterns

With Edge Encryption, you can encrypt fields and tokenize strings.

### Encryption configurations

You can encrypt individual fields using encryption configurations. Edge Encryption supports AES 128-bit encryption keys. If the Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy files are installed, Edge Encryption supports AES 256-bit encryption keys for each encryption type. Edge Encryption supports the following types of encryption configurations.

#### Standard encryption
The encrypted value of a field is different each time the field is encrypted, even when the field value remains the same. Standard encryption is the most robust form of encryption. Fields using standard encryption cannot be sorted, grouped by, or filtered on.

**Equality-preserving encryption**

The encrypted value of a field is the same when the field value remains the same. Supports equality comparisons and group by operations on a field.

**Note:** When equality-preserving encryption is selected for a field that already contains data, performing a group by action on the field may not group fields with the same value if one is encrypted and the other is not.

**Order-preserving encryption**

Uses tokens and encryption to secure data in your proxy database. Supports equality comparisons, group by operations, and the ability to sort data. The order preserving encryption type is only supported if there is a MySQL database configured for the Edge Encryption proxy server.

**Note:** When using order-preserving encryption and the proxy database is down, updates can be made to fields using order-preserving encryption. However, the sort order will not be correct when trying to sort data based on those fields. Groups also will not work as expected. When the proxy database is again operational, schedule an order token repair job to repair missing tokens.

**Encryption types**

The following encryption types are listed in decreasing security quality.

<table>
<thead>
<tr>
<th>Encryption type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard AES 256</td>
<td>Fields cannot be filtered, sorted, or compared.</td>
</tr>
<tr>
<td>Standard AES 128</td>
<td>Fields cannot be filtered, sorted, or compared.</td>
</tr>
<tr>
<td>Equality preserving AES 256</td>
<td>Fields can be filtered using equality comparisons.</td>
</tr>
<tr>
<td>Equality preserving AES 128</td>
<td>Fields can be filtered using equality comparisons.</td>
</tr>
<tr>
<td>Order preserving AES 256</td>
<td>Fields can be sorted and equality comparison filtering can be used. Requires the use of a MySQL database in your network.</td>
</tr>
<tr>
<td>Order preserving AES 128</td>
<td>Fields can be sorted and equality comparison filtering can be used. Requires the use of a MySQL database in your network.</td>
</tr>
</tbody>
</table>

**Encryption Patterns**

You can secure sensitive data found in strings using encryption patterns. Once an encryption pattern is stored and activated, the Edge Encryption proxy server identifies strings that match the pattern in requests. Once located, the clear text string is stored in the proxy database and replaced on the instance with a token. Use encryption patterns to tokenize strings that match regular patterns such as social security and credit card numbers. While we recommend that encryption configurations be the primary method of encryption, use encryption patterns as a supplement to locate and secure sensitive information found outside of encrypted fields.
**Note:** The Edge Encryption proxy server requires a MySQL database in your network only if using order preserving encryption or encryption patterns. Clear text values are stored in the proxy database in your network. For this reason, it is critical that you secure and regularly back up your proxy database. For recommendations, see Edge Encryption components.

## Installed with Edge Encryption

Edge Encryption installs tables to store encryption-related data, system properties to configure default behavior, and the `edge_encryption` role to administer Edge Encryption.

### Tables

Edge Encryption adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Encryption Configuration</td>
<td>Contains encrypted fields and tables for which attachments are encrypted.</td>
</tr>
<tr>
<td>[sys_encryption_configuration]</td>
<td></td>
</tr>
<tr>
<td>Edge Encryption Rule</td>
<td>Contains a record for each rule. A rule has a name, the condition when it is used, a script, and an order field.</td>
</tr>
<tr>
<td>[sys_encryption_rule]</td>
<td></td>
</tr>
<tr>
<td>Edge Encryption Invalid Insert Log</td>
<td>Contains log messages created for attempts to save unencrypted data to an encrypted field.</td>
</tr>
<tr>
<td>[sys_edge_encryption_invalid_insert_log]</td>
<td></td>
</tr>
<tr>
<td>Edge Encryption Proxy</td>
<td>Contains information about the encryption proxy application.</td>
</tr>
<tr>
<td>[sys_encryption_proxy]</td>
<td></td>
</tr>
<tr>
<td>Edge Proxy Encryption Type</td>
<td>Used for enabling and disabling encryption types on the encryption form.</td>
</tr>
<tr>
<td>[sys_proxy_encryption_type]</td>
<td></td>
</tr>
<tr>
<td>Encryption Job Execution</td>
<td>Supports mass encryption jobs.</td>
</tr>
<tr>
<td>[sys_encryption_job_execution]</td>
<td></td>
</tr>
<tr>
<td>Encryption Job Execution Chunk</td>
<td>Supports mass encryption jobs.</td>
</tr>
<tr>
<td>[sys_encryption_job_execution_chunk]</td>
<td></td>
</tr>
<tr>
<td>Scheduled Encryption Job</td>
<td>Lists scheduled jobs for encryption, decryption, key rotation, order token repair, and database recovery.</td>
</tr>
<tr>
<td>[sysauto_encryption_job]</td>
<td></td>
</tr>
<tr>
<td>Encryption Key Configuration</td>
<td>Lists default encryption keys.</td>
</tr>
<tr>
<td>[sys_encryption_key_configuration]</td>
<td></td>
</tr>
<tr>
<td>Encryption Key</td>
<td>Lists available keys and key attributes.</td>
</tr>
<tr>
<td>[sys_encryption_key]</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.edge.pattern.disallowed.chars</td>
<td>A list of characters that are not allowed in patterns.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: a string of a comma-separated list of values</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Properties [sys_properties] table</td>
</tr>
<tr>
<td>glide.edge.pattern.min.size</td>
<td>The minimum pattern size allowed. Allowing smaller patterns means finding more matches, which increases overhead.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: number</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 5</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Properties [sys_properties] table</td>
</tr>
<tr>
<td>sn.edge_encryption.logging.destination</td>
<td>Where messages are logged.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: string</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: file</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Properties [sys_properties] table</td>
</tr>
<tr>
<td>sn.edge_encryption.logging.verbosity</td>
<td>The logging level to use.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: string</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: info</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Properties [sys_properties] table</td>
</tr>
<tr>
<td>sn.edge_encryption.encryption.proxy.buildtag</td>
<td>The proxy version registered with your instance.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: string</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Properties [sys_properties] table</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>sn_edge_encryption.cleartext.allowed</td>
<td>When true, allows clear text to be saved in an encrypted field. This happens when a user is accessing the instance without going through the Edge Encryption proxy. When false, the system prevents clear text from being saved in an encrypted field.</td>
</tr>
</tbody>
</table>
| • **Type**: Boolean  
• **Default value**: false  
• **Location**: System Properties [sys_properties] table |

### Roles installed with Edge Encryption

<table>
<thead>
<tr>
<th>Role title</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>edge_encryption</td>
<td>Edge Encryption proxies log into the instance as a user, with a user name and password. The user must have this role assigned.</td>
<td>None</td>
</tr>
</tbody>
</table>

### Planning for Edge Encryption

Successful implementation of Edge Encryption requires planning and preparation. Answer the following questions in the planning stage.

- Which fields are to be encrypted?
- Which encryption types are to be used?
- How many Edge Encryption proxies are needed? See [Sizing your Edge Encryption environment](#) for recommendations and considerations.
- If an order preserving encryption type or encryption patterns are to be used, where is the MySQL database located?
- Which key management system is to be used?

System administrators, network administrators, and security team members have different tasks to fulfill for implementing Edge Encryption.

- System administrators need the security-admin role. The system administrator needs to:
  - Download the Edge Encryption proxy application.
  - Set up an Edge Encryption user account for the proxies to use to connect to the instance. The user must be assigned the edge_encryption role.
  - Configure encryption keys, and set the default keys.
  - Configure Edge Encryption on the instance.
  - Schedule encryption jobs.
  - Monitor Edge Encryption.
  - Create and edit encryption rules.
Your network administrator needs to:

- Install the Edge Encryption proxy application.
- Know the network addresses for the proxy servers and the proxy database used for order-preserving encryption and encryption patterns.
- Install the proxy database to be used for order-preserving encryption and encryption patterns.
- Start and stop the proxy applications.
- Perform encryption key management.
- Determine how to map users to encryption proxy applications. This can be done with DNS settings or routing rules, and is specific to each network.
- Manage multiple proxy servers.
- Configure load balancer pools and settings.

Your security administrator must determine the encryption types to be assigned to each field.

**Edge Encryption system requirements**

You can run the Edge Encryption proxy application on servers or virtual machines that run on Microsoft Windows or Linux operating systems. For optimum performance, ensure that your configuration meets these requirements.

**Java requirements**

The host machine installing or running the Edge Encryption proxy server must maintain a supported version of Java:

- Java 8 update 121 (8u121)
- Java 8 update 141 (8u141)
- Java 8 update 151 (8u151) or later

ℹ️ Note: Java 8 update 131 (8u131) is not supported.

ℹ️ Note: Before installing the Edge Encryption proxy server, check that the $JAVA_HOME variable is pointing to a supported version of Java for each user that will run the proxy server. For example, if installing the proxy server as a local administrator on Windows, check that the $JAVA_HOME variable is pointing to the correct version of Java system-wide. If installing on Linux, check that each user that will run the proxy server has this variable correctly defined. If a supported version of Java is not found, the Edge Encryption proxy server will not run.

<table>
<thead>
<tr>
<th>Java Version</th>
<th>Enabling AES 256-bit Encryption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java 8 update 141 (8u141) or earlier</td>
<td>Install the Java Cryptography Extension (JCE) jurisdiction policy files by copying them into the system Java home directory of each Edge Encryption proxy server host. Add these files to the <code>&lt;Java-home-directory&gt;/jre/lib/security</code> folder before performing a scheduled or manual upgrade. To install the AES 256-bit encryption policy files, see Enable AES 256-bit encryption for Java 8 update 141 (8u141) or earlier.</td>
</tr>
</tbody>
</table>
Java Version | Enabling AES 256-bit Encryption
---|---
Java 8 update 151 (8u151) or later | A `java.security` file is downloaded with the update. Edit the `java.security` file to enable AES 256-bit encryption.

To edit the `java-security` file, see Enable AES 256-bit encryption for Java 8 update 151 (8u151) or later.

**Note:** If upgrading an Edge Encryption proxy server running on Windows to a new version of Java, you may need to copy the JCE policy files from your previous Java folder to the new Java folder.

**Note:** Java does not automatically allow unlimited strength keys. You must specifically enable the use of AES 256-bit encryption.

### Proxy server minimum configuration

A proxy server requires this minimum configuration:

- 4 GB of RAM per proxy server (6 GB is recommended for most deployments).

**Note:** The proxy server host requires at least 1 GB of RAM more than the proxy server. The proxy server host needs the extra 1 GB for operating system services. For example, if you configure a proxy server to use 4 GB of RAM, you must install at least 5 GB of RAM on the proxy server host.

Because the proxy server requires at least 4 GB of memory, 32-bit JREs and 32-bit operating systems are no longer supported starting with the London release.

- 3 or more GHz CPU (4-core CPU preferred for optimum performance).
- Multiple proxy servers behind a load balancer. The number of proxy servers you need depends on the number of application nodes, the number of simultaneous users, and the number of servers needed for failover. See Sizing your Edge Encryption environment for more information.
- Ability to run concurrently with other services, depending on the server utilization and resource availability.
- Java 8.

### Proxy server supported systems

The following systems are supported:

<table>
<thead>
<tr>
<th>Supported System</th>
<th>Description</th>
</tr>
</thead>
</table>
| Windows Server 2012, 2012-R2, and 2016 editions | • Virtual machines or physical hardware  
• 64-bit systems |
## Proxy server connection requirements

The proxy server that runs the Edge Encryption application must be able to communicate with machines in your network. Make sure that the proxy server has these network privileges:

<table>
<thead>
<tr>
<th>Network Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firewall access</td>
<td>Configure any firewalls between the proxy server and the client devices to allow a connection. If your network uses a DeMilitarized Zone (DMZ) to add an extra layer of security to your Local Area Network (LAN), and if your network security protocols limit port access from within the network to the DMZ, you might have to deploy a proxy server to a machine within the DMZ.</td>
</tr>
<tr>
<td>Network access</td>
<td>Configure each client to enable the proxy server to connect with it. If network security prevents you from configuring new machines that can connect to the clients, install the proxy server on an existing machine with connection privileges.</td>
</tr>
<tr>
<td>Instance access</td>
<td>Ensure that the proxy server has network access to the instance. Make sure that you configure the proxy server network to allow traffic over TCP port 443.</td>
</tr>
<tr>
<td>Network account</td>
<td>Install the proxy server with either a local or domain administrator.</td>
</tr>
</tbody>
</table>

## Order-preserving and tokenization database system requirements

Order-preserving encryption and encryption patterns require that you configure an Oracle MySQL database for the Edge Encryption proxy server. Order-preserving encryption allows any comparison operation to be directly applied on encrypted data, without first decrypting the data. Encryption patterns let you replace string patterns with tokens (called tokenization) before they are sent to and stored in the database. Because of the size of the MySQL database, use a dedicated proxy server to run the order-preserving and tokenization database.

The minimum database system requirements include:

<table>
<thead>
<tr>
<th>MySQL Database</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>MySQL database versions 5.5 to 5.7</td>
</tr>
<tr>
<td>OS</td>
<td>64-bit systems</td>
</tr>
</tbody>
</table>
### Requirements

<table>
<thead>
<tr>
<th>MySQL Database</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>2 or more GHz CPU (4-core CPU preferred for optimum performance)</td>
</tr>
<tr>
<td>RAM</td>
<td>16 GB</td>
</tr>
<tr>
<td>Disk</td>
<td>Storage Area Network (SAN) or local storage (RAID 10 recommended)</td>
</tr>
<tr>
<td>Size</td>
<td>Determined by the number of potential records multiplied by the record size. See Calculate the order-preserving and tokenization database size.</td>
</tr>
<tr>
<td>Configuration</td>
<td>High availability cluster. If you are unsure of how to configure your MySQL server, contact MySQL for configuration information.</td>
</tr>
</tbody>
</table>

## Sizing your Edge Encryption environment

Choosing the number of proxy servers for your environment is an important task. Consider the number of users, redundancy needs, and acceptable latency.

### Redundancy

Maintain redundant proxy servers in case of hardware failure. Proxy servers should be located behind a load balancer to provide a functional path for all users if a proxy server is unreachable. At a minimum, ensure that two proxy servers are always available.

### Size

Size refers to the number of proxy servers required to avoid additional latency that the encryption of data produces. Depending on use, you may want to reduce the amount of latency by adding additional proxy servers. For example, if regular mass encryptions are run, add additional proxy servers to handle the load, or run the mass encryptions when the user load is light. In addition, the hardware that the proxy server runs on influences performance and latency. Proxy servers running on hardware with faster CPUs, more CPUs, and more RAM have higher throughput than slower, limited systems.

The following guidelines assume that your proxy server is running on at least the minimum hardware requirements. To determine the number of proxy servers:

- Consider setting up one proxy server for every two application nodes on the instance.
- For redundancy, set up a minimum of two proxy servers behind a load balancer.
- Add an extra proxy server for every 500 simultaneous users.
- Depending on the desired redundancy, add additional proxy servers for failover.

For example, for an instance with 2,000 users, you should have at least five proxy servers behind a load balancer. This calculation includes one proxy server for every 500 users, with an extra proxy server for failover. Determine ahead of time when you will approach a threshold of 500 users and place another proxy server in the load balancer pool.
Load balancers

To balance requests and improve server response time, distribute proxy servers in a load balancer pool. Configure load balancers to use the "least connections" method. This method connects requests to the proxy server with the fewest active connections, preventing the overloading of a single proxy.

CPU utilization

Because data encryption and tokenization are CPU intensive operations, CPU spikes while encrypting data are normal and expected. When CPU utilization is over 80% for several minutes at a time, it likely means that the proxy server has too much work to do. When this happens, latency increases for the period that the CPU utilization is high. If latency persists, adding another proxy server may help decrease the latency.

Memory

The proxy server must have a minimum of 4 GB of RAM available (6 GB recommended). Set the proxy server initial and upper bound memory limits to the recommended settings.

Calculate the order-preserving and tokenization database size

If using order-preserving encryption or encryption patterns, determine the size of your MySQL database by multiplying the number of potential records by record size.

Use a dedicated machine to run the order-preserving and tokenization database. Do not run the database on the same hardware as the proxy server.

1. Determine the potential number of records that could include fields encrypted with order-preserving encryption.
   a) Multiply the number of encryption configurations using order-preserving encryption by the number of records each configuration is applied to.
   b) To allow for growth, multiply the result by three.

2. Multiply the result of step 1 by 1,536.
   1,536 is the average size of a record in bytes.

3. If using encryption patterns, perform steps 1–2 for tokenized records and add the result to the total.

The calculated value is the recommended size in bytes for your order-preserving and tokenization database.

Edge Encryption limitations

Edge Encryption impacts system functions. Carefully evaluate the impact of encrypting a field.

Field type restrictions

You can encrypt only the following field types:

- String
- Date
- Date/Time
- Journal
• Journal Input
• URL

You cannot encrypt the following field types:
• Choice fields
• Virtual fields
• Fields in system tables, except for certain fields in sys_user
• System fields in tables
• Number fields or fields associated with an auto-numbering scheme
• Any other field type not listed above

Additional restrictions:
• When a Journal field is encrypted, the Post button is disabled, even if there are multiple Journal fields and only one of those fields is encrypted.
• Encrypted fields are not available in Go to and header filter boxes.
• When encrypting fields used as an index, you can use only order-preserving and equality-preserving encryption types. Indexed fields cannot be encrypted using the standard encryption type.

For more information, see Field types.

Filtering and searching restrictions

Standard encryption
When you select a String, Date, Date/Time, or URL field with a standard encrypted field configuration as the left operand in a filter, no filtering options are available.

Equality-preserving encryption
When you select a String, Date, Date/Time, or URL field with an equality-preserving encrypted field configuration as the left operand in a filter, the following operators are available:
• is
• is not
• is empty
• is not empty

Order-preserving encryption
When you select a String field with an order-preserving encrypted field configuration as the left operand in a filter, the following operators are available, in addition to is, is not, is empty, and is not empty:
• greater than
• less than

When you select a Date or Date/Time field with an order-preserving encrypted field configuration as the left operand in a filter, the following operators are available, in addition to is, is not, is empty, and is not empty:
• after
• before
• after or on
• before or on
**Date and Date/Time pickers**

For Date fields, use the date picker to specify the date:

![Date Picker](image1)

For Date/Time fields, use the date and time picker to specify the date and time:

![Date/Time Picker](image2)

**List condition filters**

The Show Matching and Filter Out options are supported in lists. Only exact matches are returned or filtered out.

**Note:** Adding encrypted fields in condition filters is supported in scripts such as UI policies and business rules.

**Configuration restrictions**

Restrictions and behavior of encryption configurations:

- After you add a field to the Edge Encryption Configuration table, you cannot delete the configuration record. If you no longer want a field to be encrypted, deactivate the record in the Edge Encryption Configuration table and schedule an encryption job to decrypt the data.
• If a field in a parent table is marked to be encrypted, the field is also encrypted in all inherited tables. For example, if the Short description field in the Task table is encrypted, then the contents of the Short description field in the Incident table are encrypted.

• If a field inherited from a parent table is marked to be encrypted, the field in the parent table cannot be encrypted. For example, if the Short description in the Incident table is marked to be encrypted, then the Short description in the Task table cannot be encrypted. In this example, you can encrypt the Short description in the Problem table.

• When a field with an encryption configuration defined is exported to any format, the output includes encrypted values even when exported through the proxy server.

• You cannot import data to a field with an encryption configuration defined.

• You cannot encrypt inherited Date and Date/Time fields. Date or Date/Time fields inherited from a parent table are not listed on the Column field drop-down list, and you cannot create Date or Date/Time encryption configurations for those fields.

• You can encrypt a String or URL field only from a parent table or a child table, but not both.

Instance restrictions

Impact of using Edge Encryption on the instance:

• Back-end logic cannot process encrypted data. When the instance contains encrypted data, any business rule, back-end script, or back-end feature that relies on evaluating the data in the encrypted field does not run correctly.

  Note: Data encrypted with equality-preserving or order-preserving encryption still passes equivalence checks when compared against an identical encrypted value.

• Since email processing goes from the mail systems straight to the instance and cannot pass through the Edge proxy, data sent in or out via email cannot be encrypted or decrypted by the Edge proxy.
  
  • Data and attachments in inbound emails are not encrypted.
  • Data and attachments in outbound emails remain encrypted and cannot be decrypted.

• Scripts run on the server cannot change encrypted data.

• Global search is not supported. Because global search attempts to search both encrypted and clear text data, the results may not be as expected.

• Encrypted data cannot be copied and pasted into a record where the field is not encrypted.

• Depending on the type of encryption selected, the user interface functionality for the encrypted fields is reduced. For example, being able to compare, group by, sort, and search may be impacted. Generally, the stronger the encryption selected, the more functionality is reduced.

• Except for Java KeyStore, SafeNet, and Unbound Technology, no third-party software or hardware encryption key management is supported.

• Although multiple proxy servers connected to a single instance are supported, encryption proxy cluster management and monitoring are not available. Each proxy must be managed separately.

• System configurations such as workload and the number of encrypted fields can impact the performance of encrypted fields.

• The Edge Encryption proxy server can only connect to a single instance.

• If your instance uses an Oracle database and the String field you are marking to be encrypted is greater than 2925 characters, that field cannot be sorted even when order preserving encryption is selected.

• If your instance uses an Oracle database, Unicode AL32UTF8 is the only supported character set.

• Encrypted data cannot be used in reports.
Edge Encryption installation

You can install an Edge Encryption proxy manually or using the Edge Encryption interactive installer.

Java requirements

The host machine installing or running the Edge Encryption proxy server must maintain a supported version of Java:

• Java 8 update 121 (8u121)
• Java 8 update 141 (8u141)
• Java 8 update 151 (8u151) or later

**Note:** Java 8 update 131 (8u131) is not supported.

**Note:** Before installing the Edge Encryption proxy server, check that the $JAVA_HOME variable is pointing to a supported version of Java for each user that will run the proxy server. For example, if installing the proxy server as a local administrator on Windows, check that the $JAVA_HOME variable is pointing to the correct version of Java system-wide. If installing on Linux, check that each user that will run the proxy server has this variable correctly defined. If a supported version of Java is not found, the Edge Encryption proxy server will not run.

Installing the proxy server

Installing Edge Encryption includes these steps.

• Install the Edge Encryption proxy application on a server in your network using the interactive installer or the manual installer.
• Generate the RSA key pair for digitally signing encryption configurations and encryption rules.
• Install the Java Cryptography Extension (JCE), if you plan to use AES 256 encryption.
• If you are using a secure SSL connection, obtain a server certificate and import it to the Java KeyStore.
• Set up your keystore and encryption key.
• If order preserving encryption types or encryption patterns are to be used, set up a MySQL database on a machine in your network.
• Set the desired properties. Properties are located in the edgeencryption.properties configuration file.
• Specify that a proxy server is a trusted source so that Edge Encryption can process requests coming from that proxy server.

Accessing the proxy server

Once installation is complete, point each user’s browser to an Edge Encryption proxy using the URL format: `<host>:`:<`port>`. Values are determined by the host and port properties in the edgeencryption.properties file.

As an example with the following values:

<table>
<thead>
<tr>
<th>Property</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.proxy.host</td>
<td>hostname.mycompany.com</td>
</tr>
</tbody>
</table>
A client will access the proxy server using the following address: http://hostname.mycompany.com:8081/.

Note: DNS settings and routing rules may be used. Host and port values are determined by your network administrator.

**Request Edge Encryption**

The Edge Encryption plugin (com.glide.edgeencryption) is available as a separate subscription.

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and sub-production instances, generally within a few days.

If you do not have an account manager, decide to delay activation after purchase, or want to evaluate the product on a sub-production instance without charge, follow these steps.

**Role required: none**

1. Navigate to **System Applications > All Available Applications > All.**
2. On the All Applications page, click **Request Plugin** to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.

![Activate Plugin]

In order to enhance the user experience, we have redesigned Activate a Plugin service catalog. Please use the new HI Service Portal 'Activate a Plugin' service catalog item. You can also use Manage Instances page on Service Portal to Activate a Plugin.

Take me to the HI Service Portal Activate a Plugin Service Catalog.

4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click Submit.

**Set up an Edge Encryption user account**

The Edge Encryption proxies connect to the instance as a user to obtain and update encryption configuration information. Create a user account for this purpose and give the edge_encryption role to the user.

The Edge Encryption plugin must be installed before you can assign the role.

Role required: admin

1. On your ServiceNow instance, create a user account to be used by the Edge Encryption proxy applications.
2. Assign the edge_encryption role to the user.
Download the Edge Encryption proxy server

Download the Edge Encryption proxy server application from your instance, and then copy the file to each computer that is to run the Edge Encryption proxy server.

Before starting this procedure, the Edge Encryption plugin must be installed and activated on your instance.

**Note:** The Edge Encryption proxy is officially supported only on Oracle JRE.

Role required: security_admin

1. Navigate to Encryption Configuration > Installation & Downloads > Downloads.
2. If using the interactive installer, click Download. If manually installing the proxy server, select the OS version for your proxy server.

**Note:** Because the proxy server requires at least 4 GB of memory to run, 32-bit JREs and 32-bit operating systems are no longer supported starting with the New York release.

3. Copy the installer to each computer that is to run the Edge Encryption proxy server. If manually installing the Edge Encryption proxy server, copy the ZIP file to each computer that is to run the Edge Encryption proxy server.

After downloading the Edge Encryption installer, install the Edge Encryption proxy server using the interactive installer. If installing manually, install the Edge Encryption proxy server using the command line installer.

Install the Edge Encryption proxy server using the interactive installer

Install the Edge Encryption proxy server on a Windows or Linux computer using the interactive installer.

**Note:** SafeNet KeySecure keystore files are not supported by the Edge Encryption installer. To use a SafeNet KeySecure keystore, install the Edge Encryption proxy server using the command line installer.

The Edge Encryption plugin must be installed and activated on your instance before you start this procedure. Ensure that the latest version of Java 8 is installed on the machine running the Edge Encryption installer.

The latest version of Java 8 is Java SE 8u171/ 8u172.

- Java SE 8u171 includes important bug fixes. Oracle strongly recommends that all Java SE 8 users upgrade to this release.
- Java SE 8u172 is a patch-set update, including all of 8u171 plus additional bug fixes.

Role required:

- security_admin on your ServiceNow instance
- local or domain administrator on a Windows host
- service user with full file system access on a Linux host

After installing a new proxy server, you can run the installer again to perform tests to detect issues with an installation or modify current settings. Your options include:

- **Install New:** Install a new proxy server.
- **Verify Installation:** Perform tests to detect and fix issues in a previous installation.
• **Reinstall Existing**: Perform tests to detect and fix issues in a previous installation and view or modify existing settings.

**Note**: If installing the proxy server on a Linux machine on a privileged port (port 80 or 443), you must run the installer as a root user with full file system access. To restrict file system access after the proxy server is installed, you can use the SetUID feature in the proxy installer. To enable this feature, start the installer as root or sudo root. When prompted by the installer, provide the username and usergroup of an unprivileged user. The proxy server will install with file system privileges of the given user. You can skip this step to continue the default installation with root privileges.

Use the installer to install multiple proxies for your instance on multiple machines, ensuring that the following criteria apply:

• All proxies must have the same encryption keys and the same RSA key pair used to digitally sign encryption configurations and rules.
• The encryption key must be the default key configured on the instance.
• When a proxy database is set up as part of the installation, all proxies must use the same proxy database.

You may need a proxy database for equality-preserving encryption, order-preserving encryption, or tokenization. If you do not use any of these features, you do not need a proxy database.

To use NVDA, an Assistive Technology screen reader designed to read accessibility-enabled Java applications built for keyboard users, see Configure a Windows 64-bit host to use 32-bit NVDA with Java applications.

After installing the Edge Encryption proxy server, Set the proxy server initial memory limit and upper bound memory limit.

**Install the Edge Encryption proxy server (interactive installer)**

Install the Edge Encryption proxy on a Windows or Linux computer.

1. Download the Edge Encryption proxy server installer.
2. Open the Edge Encryption proxy installer.

   **Note:** If installing on a Windows machine, you must run the installer as Administrator.

   a) To run the installer as Administrator on a Windows machine, right-click the Command Prompt and select **Run as administrator**.

   b) From the command line, navigate to the directory that contains the downloaded .jar file.

   c) Run the following command: `java -jar <file name>.jar`.

3. To install a new proxy server, select **Install New**.
   If a proxy is already installed, you can run the installer to:
   - **Verify Installation**: Perform tests to detect and fix issues in a previous installation.
   - **Reinstall Existing**: Perform tests to detect and fix issues in a previous installation and view or modify existing settings.
4. Configure the **Installation Location** and **Target ServiceNow Instance**.
   a) Click **Browse** to select an installation location or manually enter an installation path.
   b) Enter the URL of the target ServiceNow instance. Include the protocol and port number.
      `https://example.servicenow.com:443`
   c) Enter the user name and password for a user with the `edge_encryption` role on the target ServiceNow instance.

5. Click **Next**.

6. Configure the **Connection Settings** and **Proxy Settings**.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proxy Host</td>
<td>Fully qualified domain name of the machine on which you are installing the proxy server.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Click <strong>Detect FQDN</strong> to look up the machine's fully qualified domain name and auto-populate the <strong>Proxy Host</strong> field.</td>
</tr>
<tr>
<td></td>
<td>Along with the port, this property defines the URL used by the client to access the proxy server.</td>
</tr>
<tr>
<td>HTTP Port</td>
<td>Port on the proxy for HTTP communication.</td>
</tr>
<tr>
<td>HTTPS Port</td>
<td>Port on the proxy for HTTPS communication.</td>
</tr>
<tr>
<td>Proxy Name</td>
<td>Name of the proxy and the service. The proxy name must be unique.</td>
</tr>
<tr>
<td>Proxy Poll Interval</td>
<td>Poll interval in seconds. With the default setting, it takes 5 seconds for the proxy to learn of encryption configuration changes. Larger values cause the instance to take longer to detect proxies that have come online.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Changing the default setting of the <strong>Proxy Poll Interval</strong> can result in detection delays when a proxy comes online.</td>
</tr>
<tr>
<td>Proxy Keep-Alive Ping Interval</td>
<td>Time in seconds between pings issued by the proxy to the instance. Pings are issued periodically to verify connectivity between the proxy and the instance. The default value is 10. The minimum value is 5.</td>
</tr>
</tbody>
</table>

7. Click **Install**.
   The Edge Encryption proxy server installs. The installation may take a few minutes.

**Configure CyberArk properties protection**

Optionally, configure CyberArk properties protection to securely store Edge Encryption passwords in a centralized and secure digital vault.

You must purchase and configure CyberArk AIM (Application Identity Management) before you can configure CyberArk connection parameters and protected credentials for a proxy server. As part of the installation of the AIM client, the `JavaPasswordSDK.jar` file is installed in the AIM client installation directory. The CyberArk vault is installed on an independent hardened server, and the AIM clients allow secure access to that server.
Note: You must install the CyberArk AIM client on every host computer where an Edge proxy is installed.

In the Edge installer, you must specify the location of the `JavaPasswordSDK.jar` file to set up the CyberArk connection to the Edge proxy. You must also enter other values you defined during the AIM client installation.

Setting up CyberArk password storage is optional. If you do not want to set up CyberArk password storage, click **Skip** through the CyberArk screens.

1. On the CyberArk Connection page of the Edge Encryption installer, enter the CyberArk connection parameters.

   **CyberArk connection parameters**
   
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path to PasswordSDK.jar</td>
<td>The path to the <code>JavaPasswordSDK.jar</code> file installed on the host Windows machine during CyberArk configuration.</td>
</tr>
<tr>
<td>App ID</td>
<td>The <strong>App ID</strong> entered during CyberArk configuration.</td>
</tr>
<tr>
<td>Safe Name</td>
<td>The <strong>Safe Name</strong> entered during CyberArk configuration.</td>
</tr>
</tbody>
</table>

2. Click **Next**.

3. On the CyberArk Protected Credentials page of the installer, enter the credentials to be protected by CyberArk.
   - To use a single credential name for all protected passwords, select the **Apply one Credential Name to all Credentials** check box, enter the credential name, and click **Apply**.
   - Enter the credential name for one or more of the following fields. Credential names are the usernames entered for the SSH keys during CyberArk configuration.

   **CyberArk protected credentials**
   
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Encryption User</td>
<td>The CyberArk credential name for an Edge Encryption user.</td>
</tr>
<tr>
<td>Signature Key Keystore</td>
<td>The CyberArk credential name for the signature key keystore.</td>
</tr>
<tr>
<td>HTTPS Cert Keystore</td>
<td>The CyberArk credential name for the HTTPS certification keystore.</td>
</tr>
<tr>
<td>Encryption Key Keystore</td>
<td>The CyberArk credential name for the encryption key keystore.</td>
</tr>
<tr>
<td>Database</td>
<td>The CyberArk credential name for the database keykeystore.</td>
</tr>
<tr>
<td>SafeNet HTTPS Cert Keystore</td>
<td>The CyberArk credential name for the SafeNet HTTPS certification keystore.</td>
</tr>
<tr>
<td>SafeNet Server</td>
<td>The CyberArk credential name for the SafeNet server.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Forward Proxy</td>
<td>The CyberArk credential name for the forward proxy.</td>
</tr>
</tbody>
</table>

4. Click Next.

**Configure the signature key**

Configure the signature key after installing the proxy server through the Edge Encryption proxy installer.

The signature key signs changes to configurations and properties made by the proxy server. The signature key must be an asymmetric RSA key pair in a JCEKS KeyStore.

**Note:** If installing multiple proxies, each proxy must use the same signature key.

1. On the Signature Key page of the Edge Encryption installer, select the keystore on the host machine to store the signature key.
   - **Create New Java KeyStore**: Enter the directory location, name, and password for the new keystore.
   - **Use Existing Keystore**: Enter the keystore file location and password.
2. Click Next.
3. Select or create a signature key.
   - **New Key**: Create a signature key for this proxy.
   - **Use Existing Key**: Use an RSA key-pair from the selected keystore.
   - **Import Existing Key**: Import an RSA key-pair from a different keystore. Browse to the keystore file, enter the password for the keystore, and select the key alias. Provide a new alias for the key.
4. Click Next.

**Configure the HTTPS certificate**

To enable clients to connect to the Edge Encryption proxy server using a secure SSL connection, import the HTTPS certificate to the proxy server.

The Edge Encryption proxy provides the HTTPS certificate to clients trying to connect.

1. On the HTTPS Certificate page of the Edge Encryption installer, select the keystore to store the certificate.
   - **Create New Java KeyStore**: Enter the directory location, name, and password for the new keystore.
   - **Use Existing Keystore**: Enter the keystore file location and password.
2. Click Next.
3. Select or import a certificate.
   - The key alias is the given alias for the certificate.
   - **Use Existing Certificate**: Use an existing certificate in the selected keystore.
   - **Import from File or KeyStore**: Import a certificate from a different keystore or a .cer file. Browse to the keystore or .cer file, enter the password, and select the alias. You must provide a new alias for the certificate.
4. Click Next.
Configure the AES 128-bit encryption key

After you configure the HTTPS certificate through the Edge Encryption proxy installer, configure the AES 128-bit encryption key to encrypt your data.

The encryption key is either a plain text file inside the /keys directory or a secret key inside a keystore. If you use a keystore for your AES 128-bit and AES 256-bit encryption keys, they must both use the same keystore.

If you are updating an SSL certificate on an Edge proxy server, see Update SSL certificate.

1. Select the encryption key location.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Store</td>
<td>Use a file to store a single encryption key. You can use an existing file in the /keys directory, or you can generate a new file. To generate a new file, enter an alias and click Generate. A file containing an encryption key is created.</td>
</tr>
</tbody>
</table>

Note: This choice designates both the storage location and the encryption key. If you select File Store, click Next and go to step 5.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create New Java KeyStore</td>
<td>Create a keystore to store the encryption key.</td>
</tr>
<tr>
<td>Java KeyStore File</td>
<td>Store the encryption key in an existing Java KeyStore file.</td>
</tr>
</tbody>
</table>

2. Click Next.

3. Select or create the encryption key.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Key</td>
<td>Create an encryption key and alias.</td>
</tr>
</tbody>
</table>

Note: You must use lowercase letters and numbers for the alias name (key name, key alias), per Java KeyStore requirements. To find out more about the keytool utility, see the Java SE Documentation.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Existing Key</td>
<td>Use an existing encryption key in the selected keystore.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Existing Key</td>
<td>Import an encryption key from a different keystore.</td>
</tr>
</tbody>
</table>

4. Click Next.
5. Configure the key on the instance according to the requirements defined in your installer.
To configure the key on the instance, navigate to the instance and define a default key. See Configure encryption keys on the instance. Ensure that the key alias, size, and type match the requirements defined in the installer.
Default Encryption Key

This step requires you to go to your instance and create a default key. Click the links below and follow the instructions. Click 'Next' when you are done setting up the default key on your instance.

The 'Key alias' must be: aes128
The 'Key size' must be: 128
The 'Type' must be: Keystore

Click here for documentation
Click here to go to your default keys

<table>
<thead>
<tr>
<th>Default key requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>6. Once the key is configured on the instance, return to the installer and click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>
Configure the AES 256-bit encryption key

After you configure the AES 128-bit key through the Edge proxy installer, you can optionally configure an AES 256-bit encryption key to encrypt your data.

The encryption key is either a plain text file inside the /keys directory or a secret key inside a keystore. If you use a keystore for your AES 128-bit and AES 256-bit encryption keys, both keys must use the same keystore. If you do not want to configure an AES 256-bit encryption key, click **Skip** to continue installing the proxy server.

If you are updating an SSL certificate on an Edge proxy server, see **Update SSL certificate**.

1. Select the encryption key location.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Store</td>
<td>Use a file to store a single encryption key. You can use an existing file in the /keys directory, or you can generate a new file. To generate a new file, enter an alias and click <strong>Generate</strong>. A file containing an encryption key is created.</td>
</tr>
<tr>
<td><strong>Note</strong>: This choice designates both the storage location and the encryption key. If you select <strong>File Store</strong>, click <strong>Next</strong> and go to step 5.</td>
<td></td>
</tr>
<tr>
<td>Create New Java KeyStore</td>
<td>Create a keystore to store the encryption key.</td>
</tr>
<tr>
<td>Java KeyStore File</td>
<td>Store the encryption key in an existing Java KeyStore file.</td>
</tr>
</tbody>
</table>

2. Click **Next**.

3. Select or create the encryption key.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Key</td>
<td>Create an encryption key and alias.</td>
</tr>
<tr>
<td><strong>Note</strong>: You must use lowercase letters and numbers for the alias name (key name, key alias), per Java KeyStore requirements. To find out more about the keytool utility, see the Java SE Documentation.</td>
<td></td>
</tr>
<tr>
<td>Use Existing Key</td>
<td>Use an existing encryption key in the selected keystore.</td>
</tr>
<tr>
<td>Import Existing Key</td>
<td>Import an encryption key from a different keystore.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. Optional: If you want to use AES 256-bit encryption, do the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java 8 update 141 or earlier</td>
<td>Install the Java Cryptography Extension (JCE) and overwrite the policy files in the Java home directory. See Enable AES 256-bit encryption for Java 8 update 141 (8u141) or earlier.</td>
</tr>
<tr>
<td>Java 8 update 151 or later</td>
<td>Edit the java.security policy file to allow the use of unlimited strength keys. See Enable AES 256-bit encryption for Java 8 update 151 (8u151) or later.</td>
</tr>
</tbody>
</table>
6. To use AES 256-bit encryption, you must also configure the AES 256-bit default encryption key on the instance by navigating to the instance and defining a default key.

See Configure encryption keys on the instance. Ensure that the key alias, size, and type match the requirements defined in the installer.

7. After the key is configured on the instance, return to the installer and click Next.

**Update SSL certificate**

When updating an SSL certificate on an Edge proxy server, you must delete the old one.

Role required: admin

When updating the SSL certificate on the Edge proxy server, you must also delete the old certificate. If you don't, the old certificate (in the form of an alias in the KeyStore file) continues to be used even though the Edge proxy server is configured to use the new certificate.

1. On the Edge proxy server, list the entries in the Java KeyStore:

   ```
   keytool -list -keystore keystore.jceks -storetype jceks -storepass MY_SUPER_PASSWORD
   ```

2. Remove the old SSL certificate:

   ```
   keytool -delete -alias MY_OLD_ALIAS -keystore keystore.jceks -storetype jceks -storepass MY_SUPER_PASSWORD
   ```

3. Add the new SSL certificate into the Java KeyStore.

**Configure the Edge Encryption proxy database**

If using order-preserving encryption types or encryption patterns, you can optionally configure the Edge Encryption proxy database properties.

To use order-preserving encryption types or encryption patterns, a MySQL database running in your network is mandatory. This task connects the proxy to the database, but it does not install or configure the database.

**Note:** If using multiple proxy servers, all proxy servers must use the same proxy database. The values entered in the installer must be the same for all proxy servers.

1. Confirm or change the database URL. This URL is the location of the proxy database.
2. In the Name field, enter the name of the proxy database. The default value is `edgeencryption`.
3. Enter the username and password for accessing the proxy database.
4. Click Next.

**Launch the Edge Encryption proxy server**

After an Edge Encryption proxy is installed and configured, you can start the proxy from the installer.

1. After configuring keys on the instance and optionally configuring the proxy database, return to the Edge Encryption proxy installer and click Launch.
2. If an issue is detected, or to check the status of your proxy server, you can click **Check Status** to verify that the proxy is running. A message displays the proxy status.

![Proxy status](image)

**Congratulations!**

The Edge Encryption proxy is ready to launch. If you would like to launch it now, hit the "Launch" button. Your instance, through the proxy, is available at:

https://172.16.16.129:8002

If you encounter any errors, validate your configuration and correct as necessary. If the problem persists, contact ServiceNow support.

![Launch](image)

**Verify and troubleshoot the Edge Encryption proxy server installation**

After your Edge Encryption proxy is installed, you can verify the installation to locate problems or start and stop the proxy.

1. Open the Edge Encryption proxy installer.
2. Select **Verify Installation**.
3. Click **Proxy Directory** and select the proxy directory.
4. Click **Run Tests**.
   Test results display.
5. Click Next.
   If an issue is encountered, you can move through the installer to correct the configuration. If no issues are encountered, the installer jumps to the Launch page. You can check the proxy status, stop the proxy, or start the proxy from the Launch page.

**Install the Edge Encryption proxy server using the command line installer**

Manually install multiple Edge Encryption proxy servers in your network.

Roles required: security_admin on your ServiceNow instance and local administrator on the host machine.

If order preserving encryption types or encryption patterns are to be used, set up a MySQL database on a machine in your network if not already present.

**Note:** If using Unbound Technology encryption keys with Edge Encryption, install the proxy server using the command line installer on the Unbound client machine. The Edge Encryption proxy server must run on the same machine as the Unbound technology client.

First, set up a single Edge Encryption proxy server. After your first proxy server is successfully running, add additional proxy servers for one instance to ensure an optimal environment. See **Sizing your Edge Encryption environment** to determine the number of additional proxy servers needed.

**Install the Edge Encryption proxy server (command line installer)**

Install an Edge Encryption proxy on a 64-bit Windows or Linux computer.

Java 8 is required to run the installer.

Install the Edge Encryption proxy server on a machine in your network using the appropriate command for your target machine. If installing the Edge Encryption proxy server on a Windows machine, you must additionally install the proxy server as a Windows service.

When you upgrade the Edge Encryption proxy server, the system backs up the old proxy in the backup-dist-upgrade-<timestamp> directory under the current installation directory. The backup directory is generated during the upgrade process and stores the old proxy information.

When you run an upgrade via the command line, a dist-upgrade.log may be generated in the directory where the command runs. The dist-upgrade.log contains logs for the upgrade process.

In case of a failed upgrade, the system creates a failed-backup.dist-upgrade-<timestamp> directory. In addition, logs/wrapper.log in the original proxy directory may also contain failure information.

1. Create the installation directory.
2. Download the Edge Encryption proxy archive file to the installation directory.
3. Open the terminal and change to the installation directory.

   **Note:** If installing on a Windows machine, you must start the Windows Command Prompt with administrator privileges.

4. Run this command for the target machine and change the variables according to your configuration:
   
   ```
   java -jar edgeencryption-<version>-all.jar -m install -n <ProxyName> --instancehost <host> -p <InstancePort> --protocol https
   ```

<table>
<thead>
<tr>
<th>Option</th>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>none</td>
<td>version</td>
<td>Version number of the Edge Encryption proxy being used to perform the current operation.</td>
</tr>
</tbody>
</table>
### Option

<table>
<thead>
<tr>
<th>Option</th>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-m</td>
<td>mode</td>
<td>The operation or mode to run in (install or dist-upgrade).</td>
</tr>
<tr>
<td>-n</td>
<td>ProxyName</td>
<td>The name of the encryption proxy instance. Use a unique ProxyName to be able to identify specific proxy instances.</td>
</tr>
<tr>
<td>--instancehost</td>
<td>host</td>
<td>The host name of your ServiceNow instance (for example, mycompany.service-now.com).</td>
</tr>
<tr>
<td>-p</td>
<td>InstancePort</td>
<td>The port of your instance. When the protocol is https, the port is normally 443.</td>
</tr>
<tr>
<td>--protocol</td>
<td>protocol</td>
<td>The protocol used to access your ServiceNow instance (typically https).</td>
</tr>
</tbody>
</table>

### Note:

Do not copy and paste commands from the browser. Occasionally, copy/paste operations cause unexpected characters to be pasted to the target machine and results in the command being executed incorrectly. It is best to type out the command by hand using documentation as a reference.

To see the help screen, execute this command without arguments: `java -jar edgeencryption-<version>-all.jar`

5. If installing on a Windows machine, install the Edge Encryption proxy as a Windows service.

   a) Optionally change the name of the service. Open the `conf/wrapper.conf` file on the new proxy and set the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>wrapper.ntservice.name</td>
<td>Unique name of the Edge Encryption proxy service.</td>
</tr>
<tr>
<td>wrapper.ntservice.displayname</td>
<td>Edge Encryption proxy service display name.</td>
</tr>
<tr>
<td>wrapper.ntservice.description (Optional)</td>
<td>Proxy server description.</td>
</tr>
</tbody>
</table>

If this step is not performed, the Edge Encryption proxy service is installed under the name **Edge Encryption**.

b) Save and close the file.

c) Open the Windows Command Prompt and `cd to ServerName_port/bin`.

d) Execute `edgeencryption.bat install`.

The `ProxyName_port` directory is created in the current directory. The `edgeencryption.properties` file is updated with the host, port, and protocol values from the command line.
Create and configure the RSA key pair for the digital signature

Create an RSA key pair that the proxy server can use to create the digital signature for signing changes to the encryption properties and configuration.

To generate and validate the digital signature, an RSA key pair must be generated and stored in the JCEKS Java KeyStore and each proxy must be configured to use this key pair. Generate an encryption key pair using the keytool command.

To use the keytool utility with a proxy installed on SElinux (CentOS), you must enable loading of shared libraries from the proxy java-installation directory. To do this, run the following command as root.

```
chcon -R -t texrel_shlib_t proxy_install_dir/java/jre /lib
```

You must use the Java 1.8 version of the keytool utility. A copy of the utility can be found in `<proxy install dir>java/jre/bin/keytool`.

1. Change to the KeyStore directory in the proxy download directory.
2. Change the default password.

   The default password is `changeme`.

   ```
   keytool -keystore keystore.jceks -storetype jceks -storepasswd -new <newpassword>
   ```

3. Create an encryption key pair.

   **Note:** Do not enter a password for the key when the keytool utility prompts for one.

   Enter this command on a single line.

   ```
   keytool -genkeypair -alias <key alias> -keyalg rsa -keystore keystore.jceks -storetype jceks -storepass <keystore password> -keysize 2048
   ```

4. Update the encryption proxy property file (`edgeencryption.properties`).
   a) Change to the `<installation directory>/conf/` directory.
   b) Open the `edgeencryption.properties` file.
   c) Enter the properties for the digital signature.

   These properties must be the same for all proxies.

5. Save and close the `edgeencryption.properties` file.

Import and configure the certificate for secure SSL connection

To use a secure SSL connection, import a server certificate and add it to the Java KeyStore.

You must obtain the server certificate before you can add it to the Java KeyStore.

1. Add a server certificate to the Java KeyStore.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you have the RSA private key in the Java KeyStore and generated the certificate from that key.</td>
<td>keytool -import -alias keyname -file server.cert -storetype JCEKS -keystore keystore.jceks -storepass pwd</td>
</tr>
</tbody>
</table>
If you have a PKCS12 (.pfx) file that contains the RSA key and the certificate.

keytool -importkeystore -destkeystore keystore.jceks -deststoretype jceks -srckeystore <PKCS12 filename> -srcstoretype pkcs12

Make sure that the private key password is the same as the Java KeyStore password.

You can run this command to change the password.

keytool -keypasswd -keystore keystore.jceks -alias <key alias>

For testing, you can use this command to generate a self-signed certificate.

keytool -genkeypair -alias cert -keystore keystore.jceks -storetype jceks -keyalg rsa

2. Update the edgeencryption.properties file.
   a) Change to the <installation directory>/conf/ directory.
   b) Open the edgeencryption.properties file.
   c) Enter the properties for the SSL certificate.
   The certificate must be the same for all proxies connecting to the same instance.

3. Save and close the edgeencryption.properties file.

Enable AES 256-bit encryption

256-bit encryption is more secure than 128-bit encryption, and you can optionally configure AES 256-bit encryption on the Edge Encryption proxy server host. How you enable AES 256-bit encryption depends on the Java update installed on each proxy server host.

Edge Encryption supports only AES 128-bit and AES 256-bit keys.

Note: Java does not automatically allow unlimited strength keys. You must specifically enable the use of AES 256-bit encryption.

Follow the procedure for the Java version that is installed on your proxy server host:

- Enable AES 256-bit encryption for Java 8 update 141 (8u141) or earlier
- Enable AES 256-bit encryption for Java 8 update 151 (8u151) or later

Enable AES 256-bit encryption for Java 8 update 141 (8u141) or earlier

Copy the Java Cryptography Extension (JCE) jurisdiction policy files to the Java home directory of each Edge Encryption proxy server host to enable AES 256-bit encryption for Java update 141 or earlier. 256-bit keys provide greater security than 128-bit keys.

Role required: admin

Your Java home directory includes the AES 128-bit policy files by default. To enable AES 256-bit encryption, you must overwrite the Java home directory policy files with the AES 256-bit policy files. You only need to download the JCE once, but you must update every Edge Encryption proxy server host.
1. Download the JCE policy 8 ZIP file from Oracle.
2. Unzip the file.
3. On each proxy server host, copy the local_policy.jar and US_export_policy.jar files into the `<Java-home-directory>/jre/lib/security` folder.

**Enable AES 256-bit encryption for Java 8 update 151 (8u151) or later**

Edit the `java.security` policy file to enable AES 256-bit encryption for Java update 151 or later. 256-bit keys provide greater security than 128-bit keys.

Role required: admin

Perform this task in the Java home directory of each Edge Encryption proxy server host on which you want to enable AES 256-bit encryption.

1. Navigate to `<jre_home>/lib/security/java.security` on the proxy server host, where `JRE_HOME` is an environment variable for both Microsoft Windows and Linux.
2. Open the `java.security` policy file and find the line for the `crypto.policy` parameter, which is commented out by default.
3. Remove the `#` character from the beginning of the `crypto.policy` line to uncomment the line, and then save the file.

**Note:** If you do not uncomment the `crypto.policy` line, Java uses `crypto.policy=limited`, which restricts encryption to AES 128-bit keys.

**Set up a keystore and encryption keys**

Set up the keystore and encryption keys used by the Edge Encryption proxy server.

1. Carefully determine the appropriate type of keystore to use based on your organization's needs.

<table>
<thead>
<tr>
<th>Supported keystore</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File store</td>
<td>Keys are stored in a file in a file system accessed by the Edge Encryption proxy server. Because encryption keys stored in a file are not encrypted, it is your responsibility to protect these files.</td>
</tr>
</tbody>
</table>
## Supported keystore

<table>
<thead>
<tr>
<th>Supported keystore</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Java KeyStore**  | A Java KeyStore:  
• Stores keys in a Java JCEKS KeyStore.  
• Is password protected and more secure than storing keys in a file in the file system.  
• Can store multiple keys. A key alias represents each key, making it easier to manage multiple keys.  

The Edge Encryption proxy ships with the Java JCEKS KeyStore file named `keystore.jceks` in the `keystore` directory. This keystore file contains the ServiceNow public key used to validate encryption rules signed by ServiceNow. |
| **Enterprise Key Management (EKM)** | **SafeNet KeySecure**  
Keys are stored and retrieved with SafeNet KeySecure key management.  
You must secure a license with Gemalto, download the libraries, and install the SafeNet KeySecure keystore on a host machine in your network before configuring the keystore on the Edge Encryption proxy server.  
**Unbound Technology**  
The base64-encoded wrapped encryption key is stored as text file on the Edge Encryption proxy server. The Unbound Technology implementation (previously Dyadic Security) maintains control of the wrapping key.  
The Edge Encryption proxy server must run on the same machine as the Unbound technology client. |

### Note:
If using a keystore other than the base system Java JCEKS KeyStore, you must import the ServiceNow public key into your keystore. The public key alias is `servicenow`.

2. Set up the keystore and encryption keys in your local network.

**Set up a Java KeyStore keystore**

You can use a Java KeyStore keystore to store encryption keys.

You must use the Java 1.8 version of the keytool utility. A copy of the utility can be found in `<proxy install dir>/java/jre/bin/keytool`.

The Edge Encryption proxy ships with the Java JCEKS KeyStore file named `keystore.jceks` in the `keystore` directory. This keystore file contains the ServiceNow public key used to validate encryption rules signed by ServiceNow.

1. Set up the keystore properties.
   a) Change to the `<installation directory>/conf/` directory.
   b) Open the `edgeencryption.properties` file.
   c) Enter the properties for the Java KeyStore.
2. Save and close the `edgeencryption.properties` file.

After setting up the Java KeyStore, Create encryption keys using the Java KeyStore keytool.

You can use the keytool shipped with the encryption proxy distribution to create AES 128-bit and AES 256-bit encryption keys.

You must use the Java 1.8 version of the keytool utility. A copy of the utility can be found in `<proxy install dir>/java/jre/bin/keytool`.

To find out more about the keytool utility, see the Java SE Documentation.

**Note:** The Java KeyStore requires that the alias name (key name, key alias) use lowercase letters and numbers.

1. Change to the keystore directory, `<installation directory>/keystore/`.
2. To create the encryption key, run one of the following commands.

```
Option                  Description
AES 128                 keytool -genseckey -alias 128bitkey
                        -keyalg aes -keysize 128 -keystore
                        keystore.jceks -storetype jceks
AES 256                 keytool -genseckey -alias 256bitkey
                        -keyalg aes -keysize 256 -keystore
                        keystore.jceks -storetype jceks
```

You add the alias on the instance when you assign default keys.

**Note:** The key password must be the same as the keystore password.

### Set up a SafeNet KeySecure keystore

If you are using a SafeNet keystore, copy a set of libraries into the proxy distribution directory.

You must install and set up the SafeNet keystore before performing this step. Secure a license with Gemalto in order to download the libraries.

**Note:** On Linux, file paths use a forward slash (/).

1. Copy these files to the `<installation directory>/lib` directory:
   - `ingrianNAE-<version>.jar`
   - `ingrianlog4j-api-<version>.jar`
   - `ingrianlog4j-core-<version>.jar`
2. Change to the `<installation directory>/conf/` directory, and open the `edgeencryption.properties` file.
3. Enter the properties for the SafeNet keystore.

An example for a SafeNet keystore using username and password authentication.

```text
edgeencryption.nae.retries = 3
edgeencryption.nae.enabled = true
edgeencryption.nae.server = url
edgeencryption.nae.port = 9000
edgeencryption.nae.protocol = ssl
edgeencryption.nae.keystore.path = keystore/safenet_truststore
edgeencryption.nae.keystore.password = password
edgeencryption.nae.user = safenet_user
edgeencryption.nae.password = safenet_password
```

An example for a SafeNet keystore using client certificate authentication. This authentication method eliminates the need to store the SafeNet server username and password in the properties file.

```text
edgeencryption.nae.retries = 3
edgeencryption.nae.enabled = true
edgeencryption.nae.server = url
edgeencryption.nae.port = 9000
edgeencryption.nae.protocol = ssl
edgeencryption.nae.keystore.path = keystore/safenet_clientcert
edgeencryption.nae.keystore.password = password
edgeencryption.nae.client.certificate = cert_name
```

4. Add or create a key in the SafeNet keystore.
   You add the key name (alias) on the instance when you assign default keys.

5. Save and close the `edgeencryption.properties` file.

Upgrade from Kingston or lower to London or higher

If you use a SafeNet NAE server for key storage with Edge, before upgrading the proxy from Kingston or lower to London or higher, you must copy Gemalto SafeNet client ProtectApp JAR files and add new properties.

**Note:** On Linux, file paths use a forward slash (/).

1. Copy the following files from `<installation directory>/lib` to a directory path that is completely outside of the proxy installation directory path:
   - `ingrianNAE-<version>.jar`
   - `ingrianlog4j-api-<version>.jar`
   - `ingrianlog4j-core-<version>.jar`

2. On the current version (not upgraded) of the proxy, update the `<installation directory>/conf/edgeencryption.properties` file by adding the following two properties:
   - `edgeencryption.ekm.provider.classname = com.snc.edgeencryption.encryption.CloudEdgeNaeKeyProvider`
   - `edgeencryption.thirdparty.vendor.library.path = <directory path to the directory where you copied the jar files in step 1>`

3. Save the changes.
4. Proceed with the upgrade to London or higher.

**Set up Unbound Technology keys**

To use Unbound Technology (previously Dyadic Security) keys with Edge Encryption, store the base64-encoded wrapped encryption key as text file on the Edge Encryption proxy server and provide the wrapping key alias. The Unbound Technology implementation maintains control of the wrapping key.
Role required: security_admin

In your Unbound Technology implementation, identify both the wrapping key and the wrapped key. Use the RSA/ECB/OAEPMWITHSHA-256ANDMGF1PADDING algorithm for wrapping and padding. Export the wrapped key in base64-encoded text format. Save the file using the key alias as the name with no file extension.

Note: If using Unbound Technology encryption keys with Edge Encryption, install the proxy server using the command line installer on the Unbound client machine. The Edge Encryption proxy server must run on the same machine as the Unbound technology client.

1. Add the wrapped encryption key in base64-encoded text format to the `<proxy-installation-directory>/keys` directory. The name of the file must be the key alias with no file extension.

2. Update the `edgeencryption.properties` file.
   a) Change to the `<proxy-installation-directory>/conf` directory.
   b) Open the `edgeencryption.properties` file.
   c) Enter the File store properties. Set the value of `edgeencryption.keyfile.directory` to `keys`. This property directs the proxy server to look for the encryption key in the `<Java-home-directory>/keys` directory.
      For more information on Edge Encryption properties, see Edge Encryption proxy server properties.
   d) Uncomment the properties for the Dyadic provider configuration. Set the value of `edgeencryption.ekm.provider.rsa.wrapping.key.alias` to the wrapping key alias in your Unbound implementation.
   e) Save and close the file.

Add the encryption key alias to the instance. The encryption key alias is the file name of the wrapped encryption key added to the `<proxy-installation-directory>/keys` directory. For example, if the file in the directory is named `myunboundkey`, add this name to the Key alias field. See Configure encryption keys on the instance.

Create an encryption key stored in a file

You can use a simple text file as a keystore. Each file holds a single encryption key.

This step creates both the key storage and the encryption key.

Note: The name of the key file must match the key alias specified in the encryption keys table in the instance. See Configure encryption keys on the instance.

1. Create a file in the `/keys` folder of the proxy server installation directory.
2. Add the encryption key to the file.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AES 128</td>
<td>Place the encryption key, exactly 16 bytes, into the file.</td>
</tr>
<tr>
<td>AES 256</td>
<td>Place the encryption key, exactly 32 bytes, into the file.</td>
</tr>
</tbody>
</table>

3. Update the `edgeencryption.properties` file.
   a) Change to the `<installation directory>/conf/` directory.
   b) Open the `edgeencryption.properties` file.
   c) Enter the properties for the file store.
   d) Save and close the file.
Configure encryption keys on the instance

Edge Encryption provides the tools to manage encryption keys without taking the proxy offline.

Role required: security_admin

Before setting up new encryption keys on the instance:

1. Create the encryption key.
2. Make the new key available to all encryption proxies. Either copy the file or Java KeyStore file to each proxy, or ensure that each proxy has access to the Java KeyStore or Enterprise Key Management (EKM) device.

Key aliases must be unique. Each key alias must have the same key size and type on each proxy, or the key cannot be assigned as the default.

1. Navigate to **Edge Encryption Configuration > Encryption Key Configuration > Set Up Keys**.
2. On the Add New Keys section of the form, complete the following steps to add a new key.

   **Note:** If using SafeNet versioned keys, an additional column appears for the **Key version**. The **Key version** cannot be edited.

   **Important:** If using SafeNet versioned keys, click the **Retrieve latest key versions** link in the Related Links to retrieve the latest version of each key from the Edge proxy.

   Rows in the list with an X in the left column can be deleted. Keys that have been used as the default or that have a **Status** of **Available** cannot be deleted.

   a) Double-click in the row that says **Insert a new row**.
   b) In the edit box, enter a name for the key, then click the check mark.

   Key aliases are lowercase letters and numbers. Capital letters are changed to lowercase letters when you click **Update**. Key aliases must be unique.

   **Note:** If using Unbound technology keys, add the encryption key alias. The encryption key alias is the file name of the wrapped encryption key added to the <proxy-installation-directory>/keys directory. For example, if the file in the directory is named myunboundkey, add this name to the **Key alias** field.

   c) In the same row, double-click in the **Key size** column.
   d) In the select box, select a key size, either **128 bits** or **256 bits**, then click the check mark.
   e) In the same row, double-click in the **Type** column.
   f) In the select box, select a key type, either **File**, **Keystore**, **SafeNet**, or **Unbound**, then click the check mark.
   g) When you are done adding keys, click **Next Step**.

   You must specify an alias, key size, and key type for each key before moving on.
3. On the Keys Status section of the form, check the State of the key and ensure that it is **Available**. This may take a few minutes. When the key is **Available**, click **Next Step**.

   **Note:** If using SafeNet versioned keys, an additional column appears for the **Key version**. The **Key version** cannot be edited.

The instance tracks the status of every encryption key available to any proxy. When a key is available on all proxies, its state becomes **Available**. If the state does not change after a few minutes, check to ensure that the key is available on all proxies. If the state remains **Unavailable**, one or more of the proxies does not have the key.

<table>
<thead>
<tr>
<th>Encryption key states</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Status</strong></td>
</tr>
<tr>
<td>Available</td>
</tr>
<tr>
<td>Unavailable</td>
</tr>
</tbody>
</table>

4. On the Change Default Keys section of the form, do one of the following:

   - Type in the key alias.
   - Click the magnifying glass icon and select an alias.

   **Note:** If using SafeNet versioned keys, an additional field appears for the **Key version**. The **Key version** is grayed out and cannot be edited.

   **Note:** If using SafeNet versioned keys, choose only the most recent key version. If you choose an earlier version, the following message appears when you click **Update** or **Next Step**:

   One of the default keys chosen is not the latest version available for the key. Please use the latest version.

   **Note:** If using SafeNet versioned keys, and if the default keys are not the latest versions of the SafeNet keys, an **Update default keys to latest version** link appears in the Related Links. Click the link to update the default keys to use the latest version.

   Click **Next Step**.

5. On the Schedule Key Rotation section of the form, schedule a mass key rotation job or single key rotation job to encrypt existing data using the new encryption key.

If you do not run a mass key rotation job or single key rotation job, existing data remains encrypted with the old key until the data is accessed again.

**Configure additional properties in the Edge Encryption properties file**

After installing the Edge Encryption proxy server in your network and setting up your keystore and keys, configure the additional Edge Encryption properties.

1. Open the `<installation directory>/conf/edgeencryption.properties` file and configure the following Edge Encryption proxy server properties:

   - Target (instance) properties
• User account properties
• Proxy properties
• If using order preserving encryption types or encryption patterns, configure the Proxy database properties
• Clear text and static IV properties

2. Save and close the file.

**Configure a web proxy**

If your network uses a web proxy, you can set up the Edge Encryption proxy to use the web proxy.

If your network does not use a web proxy, leave the web proxy properties in the configuration file commented out.

The Edge Encryption proxy server supports HTTP connection to and basic authentication with the web proxy.

1. Change to the `<installation directory>/conf/` directory.
2. Open the `edgeencryption.properties` file.
3. Configure the web proxy properties.
4. Save and close the `edgeencryption.properties` file.
5. If the web proxy is using a customer-specific server certificate, add this certificate to the JVM used by the Edge Encryption proxy server to establish trust between the web proxy and the Edge Encryption proxy server.
   a) cd to `<Java home directory>/jre/lib/security/cacerts`
   b) Execute the command:
      ```
      keytool -keystore cacerts -importcert -alias <chooseAlias> -file <certificateFile>
      ```

**Set the proxy server initial memory limit and upper bound memory limit**

Set the initial memory limit and upper bound memory limit to specify how much memory the proxy server can consume. Set these limits to avoid performance issues in your Edge Encryption implementation.

As a guideline, set both the initial memory limit and the upper bound memory limit to the same value. On any machine, allocate 2 GB of the physical memory to the operating system (OS). Then allocate the rest of the physical memory to the heap using the initial memory limit and upper bound memory limit properties. For example, on a machine with 8 GB of memory, allocate 2 GB to the OS, and allocate the remaining 6 GB (6144 m) to the initial and upper bound memory.

**Important:** If your Edge Encryption proxy server is running, you must stop and restart the proxy server after updating these properties.

1. In your proxy server directory, open `<install dir>/conf/wrapper.conf`.
2. To set the initial memory limit, add the following line at the end of the file:
   ```
   wrapper.java.additional.<number>=-Xms<min_memory_in_MB>m
   ```
   Set `<number>` to the next available `<number>` in the sequence of `wrapper.java.additional.<number>` properties defined in the `wrapper.conf` file.

   For example, you have the following list of `wrapper.java.additional.<number>` properties:
   ```
   wrapper.java.additional.1=
   wrapper.java.additional.2=
   ```
The maximum `<number>` in the above list is 2. When you add the `wrapper.java.additional.<number>=-Xms<min_memory_in_MB>m` line, set `<number>` to 3, the next available number.

**Important:** Do not leave gaps in the numbering sequence.

Set `<min_memory_in_MB>` to the number of megabytes of memory remaining after allocating 2 GB of memory to the OS.

3. Set the upper bound memory limit.

Because an upper bound memory limit is not set in the base system, the proxy server can use all available memory. If other services are running on the server, you may want to set the upper bound memory limit.

Add the following line at the end of the file:

```
wrapper.java.additional.<number>=-Xmx<max_memory_in_MB>m
```

Set `<number>` to the next available `<number>` in the sequence of `wrapper.java.additional.<number>` properties defined in the `wrapper.conf` file.

For example, you have the following list of `wrapper.java.additional.<number>` properties:

```
wrapper.java.additional.1=
wrapper.java.additional.2=
```

The maximum `<number>` in the above list is 2. When you add the `wrapper.java.additional.<number>=-Xmx<max_memory_in_MB>m` line, set `<number>` to 3, the next available number.

**Note:** Do not leave gaps in the numbering sequence.

Set `<max_memory_in_MB>` to the number of megabytes of memory remaining after allocating 2 GB of memory to the OS.

4. Save and close the file.

**Example: Setting proxy server initial and upper bound memory limits**

```
wrapper.java.additional.1 = -Djava.io.tmpdir=../tmp
wrapper.java.additional.2 = -Dcloudedge.home.dist=..
# must ensure UTF8 encoding when running on Windows
wrapper.java.additional.3 = -Dfile.encoding=UTF8
# additional properties for heap settings
wrapper.java.additional.4 = -Xms6144m
wrapper.java.additional.5 = -Xmx6144m
```

Start the Edge Encryption proxy.

**Start the Edge Encryption proxy**

After an Edge Encryption proxy is installed and configured, you can start the proxy from the command line.

Before starting the encryption proxy, verify the following:

- The Edge Encryption plugin is activated on the instance.
- The `edgeencryption.properties` file on this machine has been configured.
- If using an order preserving encryption type or encryption patterns, the proxy database is running.
Note: The first time you set up the `edgeencryption.properties` file or change properties, you may not want to set the password encryption property. After you have verified that everything is working, you can set the password encryption property, shut down the proxy, and then restart the proxy.

1. Run the proxy server.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On a Linux machine</strong></td>
<td></td>
</tr>
<tr>
<td>a.</td>
<td><code>cd</code> to <code>ServerName_port</code></td>
</tr>
<tr>
<td>b.</td>
<td>Execute <code>.startup.sh</code></td>
</tr>
<tr>
<td><strong>On a Windows machine</strong></td>
<td>Perform the following steps from the command line as admin:</td>
</tr>
<tr>
<td>a.</td>
<td><code>cd</code> to <code>ServerName_port/bin</code></td>
</tr>
<tr>
<td>b.</td>
<td>Execute <code>edgeencryption.bat start</code></td>
</tr>
</tbody>
</table>

2. Check the log on the proxy server to verify that the proxy is running.

Obfuscate passwords in the properties file

You can obfuscate passwords in the `edgeencryption.properties` file to share the properties file without revealing clear text passwords.

Make sure that the Edge Encryption proxy server is set up and successfully running before you set this property. Before setting this property, Stop the Edge Encryption proxy.

Setting this property may make it difficult to debug connection and access issues during initial startup. Only set this property in production environments after the proxy has been set up and tested successfully.

1. Change to the `<installation directory>/conf/` directory.
2. In the `conf` directory, create a text file containing a complex string or phrase that can be used as a passphrase which the proxy uses to obfuscate the passwords in the `edgeencryption.properties` file. This passphrase should be a random and complex phrase not related to the passwords themselves.
3. Open the `edgeencryption.properties` file.
4. Set the password encryption property.
5. Save and close the `edgeencryption.properties` file.

After setting this property, you can Start the Edge Encryption proxy.

Manually add an additional proxy

After the first Edge Encryption proxy is properly configured and tested, you can set up additional proxies on a Linux or Windows machine. Installing multiple proxies on the same machine is not recommended.

Add additional proxy servers on additional machines to ensure an optimal environment. See Sizing your Edge Encryption environment to determine the number of additional proxies needed.

Note: Make sure that all proxies have the same encryption keys and the same RSA key pair used to digitally sign encryption configuration and encryption rules. If a proxy database was set up as part of the installation, all proxies must use the same proxy database.

1. Install the proxy using the appropriate command. See Install the Edge Encryption proxy server (interactive installer).
2. Copy all the encryption keys and the edgeencryption.properties file from the first proxy to the new proxy.
   Encryption keys may be located in the proxy keystore, in the /keys directory, or in a SafeNet KeySecure keystore.

3. Open the edgeencryption.properties file on the new proxy.

4. Change the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.proxy.name</td>
<td>Unique name of the proxy server</td>
</tr>
<tr>
<td>edgeencryption.proxy.host</td>
<td>The server name, IP address, or fully-qualified domain name of the computer running the proxy.</td>
</tr>
<tr>
<td>edgeencryption.proxy.http.port</td>
<td>Port on the proxy for HTTP communication. Must be unique across all processes on the machine.</td>
</tr>
<tr>
<td>edgeencryption.proxy.https.port</td>
<td>Port on the proxy for HTTPS communication. Must be unique across processes on the machine.</td>
</tr>
</tbody>
</table>

5. If installing the proxy server on a Windows machine, you must change the name of the service. Open the conf/wrapper.conf file on the new proxy and add the following properties.

   **Note:** You must perform this step before launching the proxy server.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>wrapper.ntservice.name</td>
<td>Unique name of the Edge Encryption proxy service.</td>
</tr>
<tr>
<td>wrapper.ntservice.displayname</td>
<td>Edge Encryption proxy service display name.</td>
</tr>
<tr>
<td>wrapper.ntservice.description</td>
<td>Proxy server description.</td>
</tr>
</tbody>
</table>

6. Save and close the file.

7. Launch the proxy using the appropriate command. See Start the Edge Encryption proxy.

**Authenticate an Edge Encryption proxy server**

Specify that a proxy server is a trusted source so that Edge Encryption can process requests coming from that proxy server.

If a proxy server is not authenticated, the console log includes the following message:

```
WARN This Edge Encryption proxy has not yet been authenticated by the instance.
Please navigate to the matching Proxy record on your ServiceNow instance and authenticate it.
```

If you attempt to access the proxy, you receive the following message: *This site can't be reached.*

To maintain the proxy in an operational state during the upgrade process, authentication is not required until after the proxy update is successful.

Role required: admin

1. Navigate to Edge Encryption Configuration > Proxies.
2. Select the proxy and click Authenticate.
The proxy moves from **Unauthenticated** to **Pending** to **Authenticated**. The status changes from **Unauthenticated** to **Pending** when you start the authentication. When authentication is complete, the status changes from **Pending** to **Authenticated**, and you can access the proxy and Edge Encryption can accept requests from the proxy.

**Note:** If you stop and restart the proxy, the proxy remains **Authenticated** and restarts successfully.

### Stop the Edge Encryption proxy

You can stop an Edge Encryption proxy from the command line.

1. **Stop the proxy server.**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On a Linux machine</td>
<td>Execute ./shutdown.sh</td>
</tr>
<tr>
<td>On a Windows machine</td>
<td>Execute edgeencryption.bat stop To remove the Windows service, execute edgeencryption.bat remove</td>
</tr>
</tbody>
</table>

2. **Check the log on the proxy server to verify that the proxy has stopped.**

### Uninstall the Edge Encryption proxy on Linux

You can uninstall the Edge Encryption proxy. If you are upgrading the proxy, it is not necessary to shut down and uninstall the current version.

You must have access to the computer running the Edge Encryption proxy.

Before shutting down the Edge Encryption proxy, ensure that no users are connected to the instance using the proxy.

The encryption proxy running on Linux operates as a single process. You can end this process to accommodate such tasks as redeploying the encryption proxy to another host machine, updating the proxy version, updating the Java version, or changing the unique name of the encryption proxy when deploying the encryption proxy on multiple proxy servers.

1. You may want to save the **edgeencryption.properties** file before deleting the distribution directory.
2. Execute the **shutdown.sh** shell script.
3. Check the log on the proxy server to verify that the proxy server is shut down.
4. Delete the files in the distribution folder.

### Uninstall the Edge Encryption proxy on Windows

You can uninstall the Edge Encryption proxy. If you are upgrading the proxy, it is not necessary to shut down and uninstall the current version.

You must have access to the computer running the Edge Encryption proxy.

Before shutting down the Edge Encryption proxy, ensure that no users are connected to the instance using the proxy.

1. You may want to save the **edgeencryption.properties** file before deleting the distribution directory.
2. Execute **edgeencryption.bat stop**
3. Execute **edgeencryption.bat remove**
4. Check the log on the proxy server to verify that the proxy server is shutdown.
5. Delete the files in the distribution folder.

**Set up multiple provider SSO with Edge Encryption**

If implementing multiple provider single sign-on (SSO) with Edge Encryption enabled, some users may need to log in to your instance through the Edge Encryption proxy server, while other users may not. Set up multiple provider SSO to enable logging in through the Edge Encryption proxy server URL or the instance URL.

- **Role required:** admin
- **Enable the Integration - Multiple Provider Single Sign-On Installer plugin** (com.snc.integration.sso.multi.installer).
- **Enable the Edge Encryption plugin** (com.glide.edgeencryption) and ensure that one or more proxy servers are set up in your network.
- **Determine the URL for the Edge Encryption proxy server that users will log in through using multiple provider SSO.** To determine the URL of an Edge Encryption proxy server, see [Edge Encryption installation](#).

- If routing all users through the Edge Encryption proxy server, set up your identify provider record and define the proxy server URL in the **ServiceNow Homepage**, **Entity ID / Issuer**, and **Audience URI** fields.
- To route some users through the proxy server and some users to the instance, create two identify provider records. Both records use the same value in the **Identity Provider URL** field. However, one of the records routes through the proxy server, while the other routes to the instance.

1. **Enable the duplication of identity provider URLs in identity provider records.**
   A unique constraint prevents duplication of the identity provider URL in two different identity provider records. You can enable duplication of the identity provider URL in multiple IdP records by setting a field to false.
   a) Navigate to **System Definition > Dictionary**.
   b) Open the definition record for the **idp** field of in the Identity Providers table [saml2_update1_properties].
   c) Configure the form to add the **Unique** field.
   d) Ensure that the value of the **Unique** field is set to **false**.

2. **Navigate to Multi-Provider SSO > Identity Providers.**
3. Create two identity provider records for the same identity provider: one using the instance URL and one using the Edge Encryption proxy server URL.
   To create an identity provider record, see [#unique_731].
   a) For the Edge Encryption proxy server URL, complete the form using these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identity Provider URL</td>
<td>Imported from IdP metadata.</td>
</tr>
<tr>
<td>ServiceNow Homepage</td>
<td>The URL for your proxy server homepage. For example: https://&lt;proxy hostname&gt;:&lt;port&gt;/navpage.do</td>
</tr>
<tr>
<td>Entity ID / Issuer</td>
<td>https://&lt;proxy hostname&gt;:&lt;port&gt;</td>
</tr>
<tr>
<td>Audience URI</td>
<td>https://&lt;proxy hostname&gt;:&lt;port&gt;</td>
</tr>
</tbody>
</table>
b) Click **Submit**.

c) For the instance URL, complete the form using these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identity Provider URL</td>
<td>Imported from IdP metadata.</td>
</tr>
<tr>
<td>ServiceNow Homepage</td>
<td>https://&lt;instance&gt;.service-now.com/navpage.do</td>
</tr>
<tr>
<td>Entity ID / Issuer</td>
<td>https://&lt;instance&gt;.service-now.com/navpage.do</td>
</tr>
<tr>
<td>Audience URI</td>
<td>https://&lt;instance&gt;.service-now.com/navpage.do</td>
</tr>
</tbody>
</table>

d) Click **Submit**.

4. Optional: If using more than one identity provider, modify the MultiSSO installation exit.

a) Navigate to **System Definition > Installation Exits**.
   The system displays the current list of installation exits.

b) Open the **MultiSSO** installation exit.

c) Locate the following statement in the **Script** field.

```javascript
var samlResponseTxt = request.getParameter("SAMLResponse");
if (!GlideSession.get().isLoggedIn() &&
    GlideStringUtil.notNil(samlResponseTxt)) {
    var idpRecord = this.getIdPRecord(request);
    if (idpRecord) {
        SSO_Helper.debug("IdP found based on SAML response: " +
        idpRecord.getUniqueValue());
        return new SSO_Helper(idpRecord.getUniqueValue(), false, null, true);
    }
}
```

d) Replace the statement with the following code.

```javascript
var samlResponseTxt = request.getParameter("SAMLResponse");
if (!GlideSession.get().isLoggedIn() &&
    GlideStringUtil.notNil(samlResponseTxt)) {
    /* // You have two profiles that use the same IdP entity id it
       cannot use
        // the IdP issuer / entity id from the response otherwise it may
        result in the
        // wrong IdP profile. IdP initiated login will not work
        var idpRecord = this.getIdPRecord(request);
        if (idpRecord) {
            SSO_Helper.debug("IdP found based on SAML response: " +
            idpRecord.getUniqueValue());
            return new SSO_Helper(idpRecord.getUniqueValue(), false, null, true);
        }*/
    return new SSO_Helper(null, true);
}
```

**Note:** IdP initiated login does not work in this configuration.
5. Optional: If using more than one company, #unique_732. Update the sys_id of the identity provider record depending on the user.
   - To configure a user to log in through the Edge Encryption proxy server, use the sys_id of the identity provider record that uses the Edge Encryption proxy server URL.
   - To configure a user to log in to the instance, use the sys_id of the identity provider record that uses the instance URL.

### Login URLs

<table>
<thead>
<tr>
<th>URL</th>
<th>Login destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>https://&lt;instance name&gt;.service-now.com/login_with_sso.do?glide_sso_id=&lt;sys_id of IdP record for the instance URL&gt;</td>
<td>Logs in through the instance.</td>
</tr>
</tbody>
</table>

### Edge Encryption proxy server properties

The `edgeencryption.properties` configuration file located in the `<installation directory>/conf/` folder contains properties used to configure your environment.

You must restart the proxy server after making changes to any proxy server properties. Changes on the instance and changes to the `log4j.properties` do not require a proxy restart.

### Target (instance) properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.target.host</td>
<td>Host name for the instance. Must be the same for all encryption proxies connecting to the same instance. This property is set when the proxy is installed. For example, <code>instancename.servicenow.com</code></td>
</tr>
<tr>
<td>edgeencryption.target.port</td>
<td>Instance port. Must be the same for all encryption proxies connecting to the same instance. This property is set when the proxy is installed.</td>
</tr>
</tbody>
</table>
| edgeencryption.target.protocol | Instance protocol. Must be the same for all encryption proxies connecting to the same instance. This property is set when the proxy is installed. Options include: 
  - http
  - https |
User account properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.target.username</td>
<td>User name that the proxy uses to log in to the instance. The user must have the edge_encryption role. See Set up an Edge Encryption user account.</td>
</tr>
<tr>
<td>edgeencryption.target.password</td>
<td>Password that the proxy uses to log in to the instance.</td>
</tr>
</tbody>
</table>

Proxy properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.proxy.host</td>
<td>Server name, IP address, or fully qualified domain name of the computer running the proxy. Along with the port, this property defines the URL used by the client to access the proxy server.</td>
</tr>
<tr>
<td>edgeencryption.proxy.name</td>
<td>Proxy name. Must be unique for each proxy.</td>
</tr>
<tr>
<td>edgeencryption.proxy.http.port</td>
<td>Port on the proxy for HTTP communication.</td>
</tr>
<tr>
<td>edgeencryption.proxy.https.port</td>
<td>Port on the proxy for HTTPS communication.</td>
</tr>
</tbody>
</table>

SSL certificate properties

Restart your proxy if you change the value of any SSL certificate property. The system uses the HTTPS keypair on startup to establish the proxy server connection and determine how the proxy answers client requests.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.proxy.https.cert.alias</td>
<td>Alias of the certificate provided by the proxy server to connecting clients.</td>
</tr>
<tr>
<td>edgeencryption.proxy.https.keystore.path</td>
<td>Path to the keystore that contains the HTTPS certificate.</td>
</tr>
<tr>
<td>edgeencryption.proxy.https.keystore.password</td>
<td>Password for the keystore that contains the HTTPS certificate.</td>
</tr>
</tbody>
</table>

Proxy configuration locked property

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.proxylocked</td>
<td>When true, the proxy does not accept encryption configuration changes or encryption rule changes from the instance. Set this property on the production instance after all encryption configurations and rules are final.</td>
</tr>
</tbody>
</table>
## Proxy database properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.db.url</td>
<td>Proxy database location. Must be the same for all encryption proxies connecting to the same instance.</td>
</tr>
<tr>
<td>edgeencryption.db.user</td>
<td>User name for accessing the proxy database. Must be the same for all encryption proxies connecting to the same instance.</td>
</tr>
<tr>
<td>edgeencryption.db.password</td>
<td>Password to access the proxy database. Must be the same for all encryption proxies connecting to the same instance.</td>
</tr>
</tbody>
</table>
| edgeencryption.db.name           | Proxy database name. Must be the same for all encryption proxies connecting to the same instance.  
  • Default value: edgeencryption |
| edgeencryption.db.bootstrap.file | Bootstrap file for the proxy database. The file is relative to the `sql/` directory. Must be the same for all encryption proxies connecting to the same instance. |

**Warning:** Under normal circumstances, do not change this parameter.

## Digital signature properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.proxy.signature.keystore.path</td>
<td>Path and Java KeyStore file name.</td>
</tr>
<tr>
<td>edgeencryption.proxy.signature.keystore.password</td>
<td>Password. The default password is <code>&lt;changeme&gt;</code>. Change the password after installing the Java KeyStore.</td>
</tr>
<tr>
<td>edgeencryption.proxy.signature.keystore.keyalias</td>
<td>The key alias given as the <code>-alias</code> argument when the RSA key pair is generated.</td>
</tr>
</tbody>
</table>

## NAE device keystore properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.nae.retries</td>
<td>Number of retries to make.</td>
</tr>
<tr>
<td>edgeencryption.nae.enabled</td>
<td>Setting indicates whether an NAE device is available.</td>
</tr>
<tr>
<td>edgeencryption.nae.server</td>
<td>Name of the NAE server.</td>
</tr>
<tr>
<td>edgeencryption.nae.port</td>
<td>Port used by the NAE server.</td>
</tr>
<tr>
<td>edgeencryption.nae.protocol</td>
<td>Protocol used by the NAE server.</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.nae.keystore.path</td>
<td>Path to the keystore on the NAE server.</td>
</tr>
<tr>
<td>edgeencryption.nae.keystore.password</td>
<td>NAE keystore password.</td>
</tr>
<tr>
<td>edgeencryption.nae.username</td>
<td>User name to use to authenticate with the NAE device.</td>
</tr>
<tr>
<td>edgeencryption.nae.password</td>
<td>Password to use to authenticate with the NAE device.</td>
</tr>
<tr>
<td>edgeencryption.nae.client.certificate</td>
<td>Certificate located in the keystore on the NAE server. Set this property to authenticate using a certificate instead of a username and password.</td>
</tr>
</tbody>
</table>

### Clear text and static IV properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.customer.assigned.known.cleartext</td>
<td>Clear text to let the instance verify that all proxies are using the same keys. At startup, the proxy encrypts the clear text and sends the encrypted text to the instance. The instance does not know the clear text, nor are keys sent to the instance. This property must be the same for all proxies.</td>
</tr>
<tr>
<td>edgeencryption.encrypter.static.iv</td>
<td>Static IV (initialization vector) used in equality-preserving and order-preserving encryption. This property must be the same for all proxies and must be exactly 16 bytes (16 ASCII characters).</td>
</tr>
</tbody>
</table>

### Password property

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.encrypter.properties.password</td>
<td>Name of the file in the conf folder that contains a string used within a secure process to obfuscate passwords in the edgeencryption.properties file. If this property is not set, passwords in your properties file appear in clear text. Leave this property blank until after the proxy configuration has been set up and tested.</td>
</tr>
</tbody>
</table>

### Web proxy properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.webproxy.host</td>
<td>Web proxy name or IP address.</td>
</tr>
<tr>
<td>edgeencryption.webproxy.port</td>
<td>Port on the web proxy.</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.webproxy.user</td>
<td>User name used to connect to the web proxy. If your web proxy does not use authentication, leave this property commented out.</td>
</tr>
<tr>
<td>edgeencryption.webproxy.password</td>
<td>Password to use to connect to the web proxy. If your web proxy does not use authentication, leave this property commented out.</td>
</tr>
</tbody>
</table>

### Java KeyStore properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| edgeencryption.keystore.path                 | Path to the Java KeyStore. If using a file store or a SafeNet KeySecure keystore, leave this property commented out.  
Example: edgeencryption.keystore.path = keystore/keystore.jceks |
| edgeencryption.keystore.password             | Password the proxy uses to connect to the Java KeyStore. If using a file store or a SafeNet KeySecure keystore, leave this property commented out. |

### File store property

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| edgeencryption.keyfile.directory             | The directory specifies where key files are stored. If using the Java KeyStore or a SafeNet KeySecure keystore, leave this property commented out.  
Example: edgeencryption.keyfile.directory=keys |
|                                               | If using Unbound Technology keys, uncomment this property and set the value to the keys directory. |

### Unbound Technology provider properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| edgeencryption.ekm.provider.classname         | Internal class name for the implementation.  
**Warning:** Do not change this property. |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.thirdparty.vendor.library.path</td>
<td>Path to the Unbound API JAR file on the Unbound client machine.</td>
</tr>
<tr>
<td>edgeencryption.ekm.provider.rsa.wrapping.key.alias</td>
<td>Wrapping key alias in the Unbound Technology implementation. Must be the same for all proxies.</td>
</tr>
</tbody>
</table>

**General configuration properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.config.poll.interval</td>
<td>Poll interval in seconds. The default setting means that it takes 5 seconds for the proxy to learn of encryption configuration changes. Larger values cause the instance to take longer to detect an offline proxy.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning:</strong> Do not change this property. Changing the default setting of the Proxy Poll Interval can result in detection delays when a proxy comes online.</td>
</tr>
<tr>
<td>edgeencryption.rules.dir</td>
<td>Folder where the encryption rules are stored on the proxy.</td>
</tr>
<tr>
<td>edgeencryption.encryption.order_preserving.cache.enable</td>
<td>Setting determines whether caching is used to support order-preserving encryption types.</td>
</tr>
<tr>
<td>edgeencryption.encryption.order_preserving.cache.size</td>
<td>Maximum cache size, in bytes.</td>
</tr>
<tr>
<td>edgeencryption.jobs.concurrency</td>
<td>Maximum number of mass encryption jobs that can run concurrently on this proxy.</td>
</tr>
<tr>
<td>edgeencryption.jobs.requests_per_second</td>
<td>Number of http job requests per second that can be sent to the instance by this proxy.</td>
</tr>
<tr>
<td>edgeencryption.attachments.request.timeout.seconds</td>
<td>Attachment upload request timeout in seconds.</td>
</tr>
<tr>
<td>edgeencryption.request.buffer.size</td>
<td>Size of an encryption request. If an encryption request is larger than this size, the excess is saved to disk.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning:</strong> Do not change this property.</td>
</tr>
<tr>
<td>edgeencryption.httpclient.request.buffer.size</td>
<td>Size of the client request. If the client request is larger than this size, the excess is saved to disk.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning:</strong> Do not change this property.</td>
</tr>
<tr>
<td>edgeencryption.proxy.idle.timeout</td>
<td>Time in seconds after which a transaction times out.</td>
</tr>
<tr>
<td></td>
<td>• Default value: 300 (seconds)</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| `edgeencryption.proxy.keepalive.interval`     | Time in seconds between pings issued by the proxy to the instance. Pings are issued periodically to verify connectivity between the proxy and the instance.  
  • Default value: 10 (seconds)  
  • Minimum value: 5 (seconds)                                                                                                                     |
| `edgeencryption.register.retry.count`         | Maximum number of times the proxy pings the instance to try to register.  
  • Default value: 0 (no limit)                                                                                                                    |
| `edgeencryption.tokenization.exclusion.list` | Encryption patterns cannot tokenize strings found in these fields.                                                                                      |

**Proxy server performance properties**

Proxy server performance properties are not present in the configuration file by default. To change the default values, you must add the properties and restart the proxy server. For more information, see [Edge Encryption diagnostics and performance](#).  

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| `edgeencryption.stat.collection.enabled`      | Enables the collection of statistics used by the Edge Encryption proxy server performance dashboard.  
  • Default value: true  
  
  Add this property and set the value to false to disable the collection of statistics used by the Edge Encryption proxy server performance dashboard. |
| `edgeencryption.stat.collection.interval`     | Interval length in seconds during which the Edge Encryption proxy server collects statistics. The value cannot be less than 30 seconds.  
  • Default value: 30 (seconds)                                                                                                                   |

**Deprecated proxy encryption properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| `edgeencryption.encrypter.default.key128`    | Specifies the name of the current AES 128 key. An AES 128 key must be available even if it is not used. Must be the same for all proxies.  
  Perform maintenance of these keys on the instance.                                                                                               |
| `edgeencryption.encrypter.default.key256`    | Specifies the name of the current AES 256 key. Must be the same for all proxies.  
  Perform maintenance of these keys on the instance.                                                                                               |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.encrypter.key</td>
<td>Specifies the key name for each key and is used to specify the default keys. This is the key alias integrated with the metadata that is included with each encrypted item and, therefore, is stored on the instance. The key name must use lowercase letters.</td>
</tr>
<tr>
<td>edgeencryption.encrypter.type</td>
<td>Specifies the type of encryption keystore system.</td>
</tr>
<tr>
<td>edgeencryption.encrypter.file</td>
<td>Specifies the path and file name of the text file associated with the key.</td>
</tr>
<tr>
<td>edgeencryption.encrypter.password</td>
<td>Specifies the password for accessing the keystore.</td>
</tr>
</tbody>
</table>

**CyberArk integration with the Edge proxy server**

Use CyberArk to store passwords in a centralized and secure digital vault to secure passwords that were previously stored in clear text and secured by file access, or that were previously encrypted via a second file.

CyberArk AIM (Application Identity Management) prevents unauthorized access by eliminating hard-coded and visible passwords. AIM stores passwords in a digital vault on an independent hardened server, where the passwords are represented as digital credentials. The AIM clients (the Edge proxy servers) use CyberArk digital credentials and access the independent server to retrieve the secured passwords. No passwords are stored on the Edge proxy servers or in the instance.

**CyberArk digital vault credentials**

You must purchase and configure CyberArk before you can set up CyberArk integration with the Edge proxy server.

To add a credential to CyberArk (which is read by the Edge proxy), set the **Platform Name** of the credential to **Unix via SSH** and make sure you either create a **Custom** credential **Name** or write down the **Auto-generated** credential **Name**. When you configure the Edge proxy to use this credential, the proxy server matches this credential **Name** to the setting in the proxy.
Each credential entry holds a **Password** that is being secured, as well as a credential **Name** used by an application to access that password.

**Note:** CyberArk credentials are not encryption keys.

**Adding CyberArk during an Edge proxy installation**

The proxy installer includes a new configuration page for a CyberArk integration. This page is optional if you do not want to include CyberArk when installing your proxy with the proxy installer. You can also manually set up and configure CyberArk integration in the configuration file.
The proxy installer also includes a new page for CyberArk protected credentials. This page allows configurations of different properties using a single credential name or multiple credential names. This page is optional if you do not want to include CyberArk when installing your proxy with the proxy installer.
CyberArk password protection

Any password field in the Edge proxy installer that has a CyberArk credential configured in the CyberArk vault and specified on the CyberArk Protected Credentials page of the installer is grayed out and contains the message Protected by CyberArk.
Using a load balancer with the Edge proxy server

You can use a load balancer to balance the load across the proxy servers in your Edge Encryption proxy setup. If the load balancer and proxy servers are using different ports, specify the host name and HTTPS port of the load balancer to enable users to view responses on their browser.

Important: All production environments should include at least two Edge Encryption proxy servers for redundancy.

Edge request processing without a load balancer

If you are not using a load balancer, a request is processed as described below.

1. The user issues a request from a browser.
2. The browser sends the request to the Edge proxy server.
3. The proxy server sends the request to the ServiceNow instance.
4. The ServiceNow instance returns the response to the proxy server.
5. The proxy server adds its own port number in the response header before returning the response to the user's browser.

The request is completed successfully because the user can view the response from the proxy server at the port number specified in the response header.
Edge request processing with a load balancer

However, if you are using a load balancer, the user's browser communicates directly with the load balancer, not with the proxy server. A request is processed as described below.

Note: The following example uses 1025 as the proxy server port number.

1. The user issues a request from a browser.
2. The browser sends the request to a load balancer Virtual IP (VIP), also known as a Virtual Server.
3. The VIP is configured to point to the proxy server (for example, 10.2.200.148:1025), so the load balancer forwards the request to the proxy server.
4. The proxy server sends the request to the ServiceNow instance.
5. The ServiceNow instance returns the response to the proxy server.
6. The proxy server rewrites the location header in the response with values configured in the properties for risk-servicenow.dev.echonet:1025.
   - Host: edgeencryption.proxy.host
   - HTTP port: edgeencryption.proxy.http.port
   - HTTPS port: edgeencryption.proxy.https.port
7. The proxy server forwards the response to the load balancer with the location header pointing to the proxy server port.

The outcome depends on whether the load balancer and proxy servers are using the same port.

- If the load balancer and proxy servers are using the same port, the request succeeds because the user receives the response from the same port identified in the response header.
- If the load balancer and proxy servers are using different ports, the request fails because the user's browser communicates only with the load balancer, but the response is on the proxy server.

Solution

You could resolve the issue by simply using the load balancer and all Edge proxy servers on the same port, but this is not an ideal solution. A better solution is to enable the system to know which port the load balancer uses.

The following properties enable the Edge proxy server to reroute response messages to the load balancer if the proxy server and load balancer are using different ports.

- edgeencryption.proxy.rewrite.location.host specifies the host name used to access ServiceNow through the load balancer.
- edgeencryption.proxy.rewrite.location.https.port specifies the HTTPS port used to access ServiceNow through the load balancer.

Configure the load balancer

If the load balancer and proxy servers are using different ports, specify the host name and HTTPS port of the load balancer to enable users to view responses on their browser.

Roles required:

- local or domain administrator on a Windows host
- service user with full file system access on a Linux host

1. Login to the proxy server host as admin, domain admin, or a service user.
2. Navigate to the installation directory for the Edge proxy and select `conf/edgeencryption.properties`.
3. Set the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| `edgeencryption.proxy.rewrite.location.host` | If your Edge configuration includes a load balancer to balance the load among proxy servers, rewrites responses to the load balancer so requests can be completed.  
• If there is a load balancer in the proxy setup, specify the host name used to access ServiceNow through the load balancer.  
• **Optional:** If there is no load balancer in the proxy setup, can be set to the host name used by the proxy server. |
| `edgeencryption.proxy.rewrite.location.https.port` | If your Edge configuration includes a load balancer to balance the load among proxy servers, specifies the HTTPS port used to access ServiceNow through the load balancer.  
• If there is a load balancer in the configuration, specify the HTTPS port used to access ServiceNow through the load balancer.  
• **Optional:** If there is no load balancer in the configuration, can be set to the HTTPS port used by the proxy server. |

4. Save the file.

Requests can be completed because users can now view responses on their browser.

**Edge Encryption upgrades**

Both instance upgrades and proxy server upgrades require special consideration in an Edge Encryption environment.

**Instance upgrades**

Instance upgrades in an Edge Encryption environment require caution to ensure that Edge controls work properly after the instance upgrade.

During an instance upgrade, you should not add, edit, or delete the following:

- Edge Encryption configurations
- Edge Encryption rules
- Edge Encryption tokenization patterns
- Edge Encryption scheduled jobs
- Edge Encryption key configurations
- Edge Encryption scheduled upgrades
- Edge Encryption blacklist IP configurations
Any scheduled job running during the instance upgrade will not complete. To complete the interrupted job, rerun the job once the instance is upgraded. When you reschedule the job, the processing that occurred before the instance upgrade is not lost, and the job continues to process only the data that has not yet been processed.

**Proxy server upgrades**

Schedule a proxy upgrade to enable the instance to upgrade the Edge Encryption proxy server, or manually upgrade the proxy server at any time.

**Third party libraries**

Third party libraries, such as Gemalto, are lost during instance and proxy server upgrades if they are kept in the same directory. You can perform the following to prevent the loss of third party libraries during upgrades:

1. Manually add the following property to edgeencryption.properties:
   ```
   edgeencryption.ekm.provider.classname = com.snc.edgeencryption.encryption.CloudEdgeNaeKeyProvider
   ```
2. Add the `edgeencryption.thirdparty.vendor.library.path` vendor library location property and set it to `/path/to/jars`.
   For example:
   ```
   edgeencryption.thirdparty.vendor.library.path = /app/servicenow/libs
   ```
3. Copy the SafeNet JARs into that path.

After you install the third party libraries outside of the Edge Encryption installation, they are no longer lost during upgrades.

**Scheduled upgrades**

Schedule an upgrade to allow the instance to upgrade the proxy server at the scheduled time. This functionality is available by default after upgrading. A scheduled upgrade includes these events:

1. The proxy server checks with the instance to see if there is a new version available for upgrade. New versions generally become available when the instance is upgraded.
2. The administrator receives a notification upon logging in when a new version of the proxy server is available.
3. The administrator can Schedule an Edge Encryption proxy server upgrade for each proxy server.
   - **Note:** Only users with the security_admin role can create an upgrade schedule through the proxy server.
4. Once the upgrade is scheduled, the proxy server automatically upgrades at the scheduled time. During the upgrade, the proxy server is offline for only a short time.
   - **Note:** Because the proxy server restarts during the upgrade, it is offline for a short time. The amount of time is determined by your environment and how long it takes to stop and restart the proxy service.
5. During the scheduled upgrade, a new proxy directory is created and your configuration files are copied to the new directory. New properties are written to your existing properties file. The following files or directories in your old proxy directory are copied to the new proxy directory.

- /conf directory
- /keys directory
- /keystore directory
- java/jre/lib/security/cacerts file

As a result, your keys, keystores, settings, and certificates are preserved.

Note: Only the above files are copied to the new proxy directory. Any other customized files in the proxy server directory are not preserved during a scheduled upgrade. The upgrade log file can be found in the original proxy directory in the following folder: <original-proxy-directory>/tmp/upgrade-wrapper/bin.

Prerequisites for scheduled upgrades

Before scheduling an upgrade for an Edge Encryption proxy, ensure the following:

1. The JAVA_HOME environment variable points to a java installation on the machine that is outside the Edge Encryption proxy’s directory structure.
2. The JAVA_HOME environment variable points to a java installation that is at version 1.8_u144 or higher.
3. The -Djava.io.tmpdir parameter in the wrapper.conf file of the Edge Encryption proxy points to a directory that is OUTSIDE the Edge Encryption proxy’s directory structure, and the proxy has read/write/execute permissions on the directory. Optionally, you could comment out the parameter entirely so that Java uses its default tmp location.

Manual upgrades

Instead of creating an upgrade schedule, you can manually upgrade each proxy server through the command line. See Manually upgrade an Edge Encryption proxy server running on Linux or Manually upgrade an Edge Encryption proxy server running on Windows.

Proxy build status

You can easily identify whether a proxy server is out of date by navigating to Edge Encryption Configuration > Proxies > All. The status of your proxy build is indicated in the Proxy build column by the following colors:

Green
Your proxy server is up-to-date.
Yellow
Your proxy server is out-of-date and an upgrade is needed.
Orange
Upgrade failed. Your proxy server reverts to the old version to ensure that there is no downtime.
Troubleshoot a failed scheduled proxy upgrade

When a scheduled proxy upgrade fails, the proxy server reverts to the version you are upgrading from. All original data, keys, and configuration files are preserved. This process may take several minutes. Contact ServiceNow Technical Support to ensure a successful upgrade.

To determine the reason for the failure, you can check the **Failure Reason** in the upgrade schedule. In addition, the installation directory for the failed upgrade is maintained so that log files are available for troubleshooting.

**Note:** Before deleting any extra proxy directories, always confirm which directory is current by reviewing the log files. If the log files have recent activity, the proxy might be connected to your instance.

If a scheduled proxy upgrade fails repeatedly, you can manually upgrade your proxy server. See **Manually upgrade an Edge Encryption proxy server running on Linux** and **Manually upgrade an Edge Encryption proxy server running on Windows**.

Java minimum requirements

The host machine installing or running the Edge Encryption proxy server must maintain a supported version of Java:

- Java 8 update 121 (8u121)
- Java 8 update 141 (8u141)
- Java 8 update 151 (8u151) or later

**Note:** Java 8 update 131 (8u131) is not supported.

**Note:** Before installing the Edge Encryption proxy server, check that the `$JAVA_HOME` variable is pointing to a supported version of Java for each user that will run the proxy server. For example,
If installing the proxy server as a local administrator on Windows, check that the $JAVA_HOME variable is pointing to the correct version of Java system-wide. If installing on Linux, check that each user that will run the proxy server has this variable correctly defined. If a supported version of Java is not found, the Edge Encryption proxy server will not run.

If using AES 256-bit encryption with Java 8 update 141 (8u141) or lower, you must install the Java Cryptography Extension (JCE) jurisdiction policy files by copying them into the system Java home directory of each Edge Encryption proxy server host. Add these files to the `<Java-home-directory>/jre/lib/security` folder before performing a scheduled or manual upgrade. To install the AES 256-bit encryption policy files, see [Enable AES 256-bit encryption for Java 8 update 141 (8u141) or lower](#).

### Mixed proxy-version environments

Although an environment running old versions of the proxy server with up-to-date versions of the proxy server is not recommended, it is supported if all proxy servers are within the same version family as your instance. For example, if you have an instance on the New York release, your environment supports proxy servers from any New York patch or hotfix. However, the following limitations apply.

- If one proxy server supports functionality that another proxy does not support, you will see inconsistent behavior, depending on which proxy server is used.
- If a proxy server is out-of-date, it may not include recent security enhancements.

If a proxy server from a previous release is registered with a newer release of the instance, you will receive regular notifications that the proxy server is out-of-date. To ensure an optimal and secure environment, ServiceNow recommends always upgrading your proxy server to the most recent version of the software supported by your instance.

### Schedule an Edge Encryption proxy server upgrade

Create an upgrade schedule to enable the instance to upgrade an out-of-date proxy server.

To schedule an upgrade, you must be logged in to your instance through the proxy server.

If using AES 256-bit encryption with Java 8 update 141 (8u141) or lower, you must install the Java Cryptography Extension (JCE) jurisdiction policy files by copying them into the system Java home directory of each Edge Encryption proxy server host. Add these files to the `<Java-home-directory>/jre/lib/security` folder before performing a scheduled or manual upgrade. To install the AES 256-bit encryption policy files, see [Enable AES 256-bit encryption for Java 8 update 141 (8u141) or lower](#).

Role required: security_admin

Once the upgrade is scheduled, the proxy server automatically upgrades at the scheduled time. During the upgrade, the proxy server is offline for only a short time.

**Note:** Because the proxy server restarts during the upgrade, it is offline for a short time. The amount of time is determined by your environment and how long it takes to stop and restart the proxy service.

During the scheduled upgrade, a new proxy directory is created and your configuration files are copied to the new directory. New properties are written to your existing properties file. The following files or directories in your old proxy directory are copied to the new proxy directory.

- `/conf` directory
- `/keys` directory
- `/keystore` directory
- `java/jre/lib/security/cacerts` file
As a result, your keys, keystores, settings, and certificates are preserved.

**Note:** Only the above files are copied to the new proxy directory. Any other customized files in the proxy server directory will not be preserved during a scheduled upgrade. The upgrade log file can be found in the original proxy directory in the following folder: `<original-proxy-directory>/tmp/upgrade-wrapper/bin`.

If multiple proxy servers are out-of-date, you must schedule an upgrade for each proxy server individually.

**Note:** Avoid hosting multiple proxy servers on the same machine. However, if your environment includes this configuration, do not schedule upgrades to multiple proxies on the same machine at the same time.

1. Navigate to **Edge Encryption Configuration > Proxies > Upgrade Schedules**.
2. Click **New**.
3. Complete the form.

**Edge Encryption Proxy Upgrade Schedule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proxy server</td>
<td>Proxy server being upgraded.</td>
</tr>
<tr>
<td>Target version</td>
<td>Version to which you are upgrading your proxy server. This value is read-only and set to the most up-to-date proxy version available for your instance.</td>
</tr>
<tr>
<td>Scheduled Start Time</td>
<td>Date and time on which to start the upgrade.</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the scheduled upgrade is active. If this field is not selected, the upgrade will not perform on the scheduled date and time.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the upgrade. This value is read-only. Possible statuses include:</td>
</tr>
<tr>
<td></td>
<td>• Pending</td>
</tr>
<tr>
<td></td>
<td>• Running</td>
</tr>
<tr>
<td></td>
<td>• Complete</td>
</tr>
<tr>
<td></td>
<td>• Failed</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

After an upgrade is executed, you can review the upgrade details to learn more about it. If your upgrade failed, review the **Failure Reason** to determine next steps.

**Upgrade details**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Version</td>
<td>The version that the server was upgraded from.</td>
</tr>
<tr>
<td>To Version</td>
<td>The version that the server was upgraded to.</td>
</tr>
<tr>
<td>Actual Start Time</td>
<td>Time that the upgrade began.</td>
</tr>
<tr>
<td>End Time</td>
<td>Time that the upgrade ended.</td>
</tr>
</tbody>
</table>
Manually upgrade an Edge Encryption proxy server running on Linux

Update a proxy running on Linux.

If using AES 256-bit encryption with Java 8 update 141 (8u141) or lower, you must install the Java Cryptography Extension (JCE) jurisdiction policy files by copying them into the system Java home directory of each Edge Encryption proxy server host. Add these files to the `<Java-home-directory>/jre/lib/security` folder before performing a scheduled or manual upgrade. To install the AES 256-bit encryption policy files, see Enable AES 256-bit encryption for Java 8 update 141 (8u141) or lower.

Role required: security_admin or local administrator on the host machine

1. Copy the Edge Encryption update-archive file to the installation directory.
2. Change to the installation directory.
3. Run the following command:

   ```
   java -jar edgeencryption-dist-<version>-all.jar -m dist-upgrade -c <proxy directory>
   ```

   **Option** | **Description**
   --- | ---
   proxy directory | The directory in the installation directory where the proxy was initially installed. This directory is created by the install.

If you want to see the help screen, execute this command without arguments: `java -jar edgeencryption-dist-<version>-all.jar`

A new proxy directory is created with a current timestamp. A backup of the old proxy directory is maintained as backup.dist-upgrade_timestamp in the new proxy installation directory. The old proxy shuts down and the new proxy starts up. Any open connections/transactions on the old proxy server are terminated.

4. Check the proxy log in the new directory and the instance to verify that the new proxy is running.

Manually upgrade an Edge Encryption proxy server running on Windows

Update a proxy running on Windows.

If using AES 256-bit encryption with Java 8 update 141 (8u141) or lower, you must install the Java Cryptography Extension (JCE) jurisdiction policy files by copying them into the system Java home directory of each Edge Encryption proxy server host. Add these files to the `<Java-home-directory>/jre/lib/security` folder before performing a scheduled or manual upgrade. To install the AES 256-bit encryption policy files, see Enable AES 256-bit encryption for Java 8 update 141 (8u141) or lower.

Role required: security_admin or local administrator on the host machine

1. Download the Edge Encryption proxy-update archive file to the installation directory.
2. Start the Windows cmd terminal program with administrator privileges.
3. Change to the installation directory.
4. Run the following command:

```
java -jar edgeencryption-dist-<version>-all.jar -m dist-upgrade -c <proxy
directory>
```

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>proxy directory</td>
<td>The directory in the installation directory where the proxy was initially installed. This directory is created by the install.</td>
</tr>
</tbody>
</table>

If you want to see the help screen, execute this command without arguments: `java -jar edgeencryption-dist-<version>-all.jar`

A new proxy directory is created with a current timestamp. A backup of the old proxy directory is maintained as backup.dist-upgrade_timestamp in the new proxy installation directory. The old proxy shuts down and the new proxy starts up. Any open connections/transactions on the old proxy server are terminated.

5. Check the proxy log in the new directory and the instance to verify that the proxy has been updated and is running.

**Roll back an Edge Encryption proxy server upgrade**

If a proxy upgrade is unsuccessful, you can go back to the earlier version.

If an upgrade fails when using the scheduled upgrade feature in the New York release, the proxy server will automatically roll back to the old version. The old proxy server is stored unmodified in a backup directory.

If you would like to roll back a manual upgrade, you can follow these steps.

1. Shut down the proxy.
2. Delete the new proxy directory.
3. Rename the backup directory to the proxy name.
   The backup directory is in the proxy installation directory with the name `<proxy name>_backup`
4. Start the proxy.
5. Check the proxy log and the instance to verify that the proxy is online.

**Edge Encryption configuration**

After the Edge Encryption proxy server is installed and running, manage Edge Encryption through the proxy server.

You must complete all the steps in Edge Encryption installation before creating encryption configurations and encryption patterns on the instance.

**Note:** To access the Edge Encryption configuration, you must log in through the proxy server and elevate to the security_admin role.

**Rotate encryption keys**

Perform encryption key rotation from the instance. Add a new key, change the default key assignment, and then schedule a mass key rotation or a single key rotation.
Before setting an encryption key as the default key, make the key available to each proxy. This ensures that the proxies have the key to encrypt data when the key is assigned as the default key. All proxies must have access to a key before that key can be assigned as the default key.

**Warning:** Before deleting a key from the proxy, set up and run a mass key rotation job to ensure that no data on the instance uses the key. If any information is still encrypted with that key, you cannot decrypt the information after you delete the key.

### Edge filtering and sorting behavior

Whenever you change default keys, be sure to perform a key rotation (either mass or single key rotation). Otherwise, you may receive unexpected results when sorting and filtering records. For example, consider the following scenario:

1. You create encrypted records using one encryption key.
2. You create a new key and set it as default.
3. You create a new set of encrypted records using the new encryption key.

If you filter by any encrypted field when connected through the Edge proxy, all records may not be filtered out correctly, or records may appear unexpectedly. The filter works only for records encrypted using the current default key. The records encrypted using the previous default key still appear in the list view.

If you sort by any encrypted field when connected through the Edge proxy, you see two groups of records with the same human readable text in the encrypted field.

### Schedule a single key rotation job

Schedule a job to find data encrypted using a specified key alias and then re-encrypt the data with the current default encryption key. The data is decrypted before it is re-encrypted with the default key.

**Role required:** security_admin

Before scheduling this job, update the default key in Edge Encryption Configuration > Encryption Key Configuration > Set Default Keys.

1. Navigate to Edge Encryption Configuration > Maintenance > Schedule Single Key Rotation.
2. Fill in the fields on the form as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select <strong>Single Key Rotation</strong>.</td>
</tr>
<tr>
<td>Key</td>
<td>Enter the key to be retired. Verify that this key is no longer the default key in Edge Encryption Configuration &gt; Encryption Key Configuration &gt; Set Default Keys.</td>
</tr>
<tr>
<td>Estimate record count</td>
<td>Total estimated number of records to process. Not available when running a single key rotation.</td>
</tr>
<tr>
<td>Process Historical Records</td>
<td>Select to process historical records in the Audit table if the field is audited. When encrypting historical records for a field in the Audit table, both new values and old values are encrypted. This field is read only and active. To learn more about audited fields, see <strong>Auditing</strong>.</td>
</tr>
</tbody>
</table>
ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimate Maximum Audit Record</td>
<td>Estimated maximum number of audited records to process. Not available when running a single key rotation.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box if you want to deactivate this job.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the period between job executions.</td>
</tr>
<tr>
<td>Starting</td>
<td>Enter the date and time to run the job for the first time.</td>
</tr>
</tbody>
</table>

3. Click the menu icon in the form header and select **Save**.

*Estimate Record Count* is not supported when processing audited fields.

**Schedule a mass key rotation job**

Schedule a job to find data encrypted with any previous key, and then re-encrypt the data with the current default encryption keys. The data is decrypted before it is re-encrypted with the current default key.

Role required: security_admin

1. Navigate to **Edge Encryption Configuration > Maintenance > Schedule Mass Key Rotation**.
2. Fill in the fields on the form as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select <strong>Mass Key Rotation</strong>.</td>
</tr>
<tr>
<td>Estimate record count</td>
<td>Total estimated number of records to process. Not available when running a mass key rotation.</td>
</tr>
<tr>
<td>Process Historical Records</td>
<td>Select to process historical records in the Audit table if the field is audited. When encrypting historical records for a field in the Audit table, both new values and old values are encrypted. This field is read only and active. To learn more about audited fields, see <strong>Auditing</strong>.</td>
</tr>
<tr>
<td>Estimate Maximum Audit Record</td>
<td>Estimated maximum number of audited records to process. Not available when running a mass key rotation.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box to deactivate this job.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the period between job executions.</td>
</tr>
<tr>
<td>Starting</td>
<td>Enter the date and time to run the job for the first time.</td>
</tr>
</tbody>
</table>

3. Click the menu icon in the form header and select **Save**.

*Estimate Record Count* is not supported when processing audited fields.

**Schedule an attachment key rotation job**

Schedule a job to find attachments encrypted using a specified key alias, and then re-encrypt the attachments with the current default encryption key. The attachment is decrypted before it is re-encrypted with the default key.
Role required: security_admin

1. Navigate to **Edge Encryption Configuration > Maintenance > Schedule Attachment Key Rotation**.
2. Fill in the fields on the form as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select <strong>Attachment Key Rotation</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear the check mark if you want to deactivate this job.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the period between job executions.</td>
</tr>
<tr>
<td>Starting</td>
<td>Enter the date and time to run the job for the first time.</td>
</tr>
</tbody>
</table>

3. Click the menu icon in the form header and select **Save**.
4. To see an estimated count of records to be updated, click **Estimated Record Count**.
5. To run the job immediately, click **Execute Now**.

**Encrypt fields using encryption configurations**

Encrypt fields by creating encryption configurations.

To configure Edge Encryption, you must be connected to the instance through the proxy. Test all changes on a non-production instance before making the changes to the production instance.

**Define encryption keys**

After setting up one or more proxies and configuring a default encryption key, the instance verifies that the keys are available to all proxies. You cannot make an encryption key the default key unless all proxies have the key. Once a default key is defined, you can create encryption configurations.

**Assign fields and attachments to be encrypted**

Assigning fields and attachments to be encrypted means assigning an encryption type to the field or attachment. Before marking a field as encrypted, evaluate these issues.

- Determine what system features might be impacted.
- Examine all scripts for use of the field.
- Make any desired adjustments to the field size. After a field has been configured for encryption, the field size cannot be changed.

Marking a field to be encrypted expands the field size to store the encrypted data. The process of expanding the field size can take a long time, depending on the number of records in the table.

**Create an encryption configuration**

Select the fields to be encrypted and identify the encryption type.

Role required: security_admin

1. Navigate to **Edge Encryption Configuration > Edge Encryption Configurations > Create New**.
2. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table that contains the field to be encrypted.</td>
</tr>
<tr>
<td>Type</td>
<td>Whether to encrypt a table column or attachments for the table. Select <strong>Column</strong>.</td>
</tr>
<tr>
<td>Column</td>
<td>The field to be encrypted. Appears only when the <strong>Type</strong> is <strong>Column</strong>. Only String, Date, Date/Time, Journal, Journal Input, and URL fields are supported. - <strong>String and URL fields</strong>: You can add an encryption configuration to either a parent table or a child table. - <strong>Date and Date/Time fields</strong>: You can add an encryption configuration to a parent table only. You cannot add a new encryption configuration to a child table.</td>
</tr>
</tbody>
</table>

**Note:** Depending on the number of records affected by the Date and Date/Time fields you are encrypting, it may take up to a few minutes to create the encryption configuration. Make sure that you create the encryption configuration for Date and Date/Time fields when transaction volume on the instance is low.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encryption type</td>
<td>The encryption type to use.</td>
</tr>
</tbody>
</table>

**Note:** A specific table and field combination can have only one active configuration at a time.

3. Click **Submit**.

After you add the encryption configuration record, you can create an encryption job to encrypt existing data. If you do not run an encryption job, Edge encrypts the existing data the next time the data changes.

**Deactivate an encryption configuration**

After configuring a field or a table’s attachments to be encrypted, you can stop encryption by deactivating the encryption configuration. After deactivating encryption, you can run a Decryption job for fields or an Attachment Decryption job for attachments to remove the encrypted data from the instance.

Role required: security_admin

**Warning:** Deactivating an encryption configuration does not delete the encryption record and the encryption type cannot be changed.

1. Navigate to **Edge Encryption Configuration > Edge Encryption Configurations > All**. The **Edge Encryption Configurations** list is shown.
2. Click on the encryption configuration to be deactivated. The **Edge Encryption Configuration** form is shown.
3. Click on the **Active** box.
The Active box is clear.

4. Click Update.

The Edge Encryption Configurations list is shown.

You can run a Decryption or Attachment Decryption job to decrypt data on the instance. If you do not run a job, the encrypted data is decrypted the next time it is changed.

Schedule an encryption job

You can schedule a job to find and encrypt any unencrypted data in a specified field, using the default encryption key configured for the field. If you do not create an encryption job after configuring a field for encryption, only new values are encrypted.

Role required: security_admin

1. Navigate to Edge Encryption Configuration > Encryption Configurations > All.
2. Click the field that you want to schedule an encryption job for.

The Scheduled Encryption Job form is shown with all fields populated. The bottom of the form shows records for any previous job executions.

4. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box if you want to deactivate this job.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select Encryption.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table.</td>
</tr>
<tr>
<td>Column</td>
<td>Select a column.</td>
</tr>
<tr>
<td>Estimated record count</td>
<td>Total estimated number of records to process. Populates after selecting Estimate Record Count.</td>
</tr>
<tr>
<td>Process Historical Records</td>
<td>Select to process historical records in the Audit table if the field is audited. When encrypting historical records for a field in the Audit table, both new values and old values are encrypted. To learn more about audited fields, see Auditing.</td>
</tr>
<tr>
<td>Estimate Maximum Audit Record Count</td>
<td>Estimated maximum number of audited records to process. Populates after selecting Estimate Record Count. This field is only visible when Process Historical Records is selected.</td>
</tr>
</tbody>
</table>

5. Click the menu icon in the form header and select Save.

6. To see an estimated count of records to be updated, click Estimate Record Count.
7. To run the job immediately, click **Execute Now**.

### Schedule a decryption job
You can schedule a job to decrypt data in an encrypted field, to store clear data in the instance.

**Note:** You must mark the encryption record for the field as inactive (clear the **Active** box) in order to run the decryption job.

Role required: security_admin

1. Navigate to **Edge Encryption Configuration > Encryption Configurations > All**.
2. Click the field that you want to decrypt.
3. Under **Related Links**, click **Schedule Mass Decryption Job**.

The **Scheduled Encryption Job** form is shown with all fields populated. The bottom of the form shows records for previous job executions.

4. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select <strong>Decryption</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box if you want to deactivate this job.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table.</td>
</tr>
<tr>
<td>Column</td>
<td>Select a column.</td>
</tr>
<tr>
<td>Estimated record count</td>
<td>Total estimated number of records to process. Populates after selecting <strong>Estimate Record Count</strong>.</td>
</tr>
<tr>
<td>Process Historical Records</td>
<td>Select to process historical records in the Audit table if the field is audited. When encrypting historical records for a field in the Audit table, both new values and old values are encrypted. To learn more about audited fields, see <strong>Auditing</strong>.</td>
</tr>
<tr>
<td>Estimate Maximum Audit Record Count</td>
<td>Estimated maximum number of audited records to process. Populates after selecting <strong>Estimate Record Count</strong>. This field is only visible when <strong>Process Historical Records</strong> is selected. <strong>Note:</strong> The estimate may be larger than the actual number of records processed.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the period between job executions.</td>
</tr>
<tr>
<td>Starting</td>
<td>Enter the date and time to run the job for the first time.</td>
</tr>
</tbody>
</table>

5. Click the menu icon in the form header and select **Save**.
6. To see an estimated count of records to be updated, click **Estimate Record Count**.
7. To run the job immediately, click **Execute Now**.
Encrypt attachments using standard encryption

You can encrypt attachments for specific tables.

All attachments to a table use the same encryption type. Encrypted attachments are not searched when performing a text search. Only the standard encryption types are allowed for attachments. The order preserving or equality preserving encryption types are not allowed.

For a session bypassing the Edge Encryption proxy:

- On a record with attachment encryption activated:
  - The user can see that there are attachments and the attachment names.
  - The user cannot open or download the attachments.
  - The user cannot add new attachments.

- On a record without attachment encryption activated:
  - The user can open and download existing attachments.
  - The user can add new attachments.

For a session using the encryption proxy, the user can open and download existing attachments and add new attachments.

Configure attachment encryption

Select the tables whose attachments are to be encrypted and identify the encryption type.

Role required: security_admin

2. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table whose attachments are to be encrypted.</td>
</tr>
<tr>
<td>Type</td>
<td>Whether to encrypt a table column or attachments for the table. Select Attachment.</td>
</tr>
<tr>
<td>Column</td>
<td>The table field to be encrypted.</td>
</tr>
<tr>
<td>Encryption type</td>
<td>The encryption type to use. For attachments, only Standard AES128 and Standard AES256 are allowed.</td>
</tr>
</tbody>
</table>

3. Click Submit.

After the encryption record has been added, you can create an attachment encryption job to encrypt existing attachments. If you do not run an attachment encryption job, the system encrypts new attachments when you attach them.

Schedule an attachment encryption job

You can schedule a job to find and encrypt any unencrypted attachments for a specified table, using the default encryption key configured for the table.
Role required: security_admin

1. Navigate to **Edge Encryption Configuration > Encryption Configurations > All**.
2. Click the table you want to schedule an encryption job for.

   The **Scheduled Encryption Job** form is shown with all fields populated. The bottom of the form shows records for previous job executions.

4. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box if you want to deactivate this job.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select Attachment Encryption.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the period between job executions.</td>
</tr>
<tr>
<td>Starting</td>
<td>Enter the date and time to run the job for the first time.</td>
</tr>
</tbody>
</table>

5. Click the menu icon in the form header and select **Save**.
6. To see an estimated count of records to be updated, click **Estimate Record Count**.
7. To run the job immediately, click **Execute Now**.

**Schedule an attachment decryption job**

You can schedule a job to decrypt any encrypted attachments for a specified table, to store clear attachments in the instance.

**Note:** You must mark the encryption record for the table as inactive (clear the **Active** box) before the decryption job runs, otherwise, nothing happens.

Role required: security_admin

1. Navigate to **Edge Encryption Configuration > Encryption Configurations > All**.
2. Click the table with the attachments that you want to decrypt.
3. Under **Related Links**, click **Schedule Mass Attachment Decryption Job**.

   The **Scheduled Encryption Job** form is shown with all fields populated. The bottom of the form shows records for previous job executions.

4. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select Attachment Decryption.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear the check mark if you want to deactivate this job.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the period between job executions.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Starting</td>
<td>Enter the date and time to run the job for the first time.</td>
</tr>
</tbody>
</table>

5. Click the menu icon in the form header and select **Save**.
6. To see an estimated count of records to be updated, click **Estimate Record Count**.
7. To run the job immediately, click **Execute Now**.

### Change a field or attachment's encryption type

You can change a field or attachment's encryption type by selecting a new encryption type in the existing encryption configuration record. A specific table and field combination can only have one active configuration at a time.

Role required: **security_admin**

1. Navigate to **Edge Encryption Configuration > Encryption Configurations > All**. The **Edge Encryption Configurations** list is shown.
2. Open the record for the encryption configuration to be changed.
3. Click the **Encryption type** dropdown and select a new encryption type.

   **Note:** For attachments, only Standard AES128 and Standard AES256 are allowed.

4. If needed, run an **encryption** or **attachment encryption** job.

   It is not necessary to run an encryption job. If you do not run an encryption job, the field or attachment is encrypted using the new encryption type the next time the field or attachment is changed.

### Tokenize strings using encryption patterns

You can replace string patterns with tokens before they are sent to and stored in the instance.

To use encryption patterns, you must install and set up a MySQL database in your network. This is the same database used for order-preserving encryption. To create or edit encryption patterns, you must be connected to the instance through the proxy.

Role required: **security_admin**

You can use base system patterns, or create your own patterns. Base system patterns are advanced patterns. Encryption patterns include the following limitations.

- A pattern of all alpha characters is not allowed.
- The minimum pattern size is five characters. You can change this setting using a system property.
- The * and + quantifiers are forbidden in encryption patterns.
- Encryption patterns match complete words, not parts of strings embedded in a larger string. Words are defined by spaces and characters not available for inclusion in a pattern.
- If the same string is sent to the instance multiple times, it is replaced with the same token.
- Text search on exact matches is supported. The query string is exchanged with a token when sent to the instance, the search is performed on tokens, and when the search results are returned to the proxy server, the tokens are replaced with the clear text. Features such as stemming are not supported.

When using patterns, the clear text never leaves your network. When the proxy server matches a pattern in a request going to the instance, the proxy replaces the string with a token of the same size. The token is sent to instance instead of the clear text string. When the response is sent from the instance to the proxy server, the proxy replaces the token with the string. When viewed through the proxy server, the string displays as clear text.
1. Navigate to **Edge Encryption Configuration > Encryption Patterns > Create New**.
   Alternatively, you can navigate to **Advanced Patterns** to activate or edit a preconfigured pattern.

2. Enter the pattern name.

3. Define the **Edge pattern input type**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>A series of character types. In the Basic Pattern Input tab, click Add and select a character type. The Sample pattern displays the pattern as characters are added. Click New Block to move the next character to the next line. This enables you to group characters in a long pattern. Click X to delete the last character in the pattern.</td>
</tr>
<tr>
<td>Advanced</td>
<td>A Java RegEx expression. If advanced is selected, you cannot change the input type back to basic. In the Sample match field, enter a sample pattern to test the RegEx expression. In the Pattern field, enter a Java RegEx expression. Click Validate to verify that the expression matches the sample pattern.</td>
</tr>
</tbody>
</table>

The input type defines how you are going to enter the pattern. It does not impact how the pattern is used.

4. Click **Submit**.

**Repair or recover order-preserving encrypted data**

If you have the security-admin role, you can schedule jobs performed by the Edge Encryption proxy to repair or recover fields that use order preserving encryption.

You can schedule jobs to:

- Repair order tokens.
- Recreate the proxy database.

Running these jobs can be a time-consuming operation which might impact the performance of the Edge Encryption proxy. Schedule these jobs at a time when no users or a minimum set of users are using the system, such as midnight on the weekend.

**Schedule an order token repair job**

You can schedule a job to find and repair fields where the order token is missing.

Role required: security_admin

Use these jobs to repair individual fields in a table or to repair all fields using order preserving encryption. Run this job when the proxy database has been offline while the instance has been running, which results in order preserving fields that are missing order tokens.

1. Navigate to **Edge Encryption Configuration > Maintenance > Schedule Order Token Repair**.
2. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select <strong>Order Token Repair</strong>.</td>
</tr>
<tr>
<td>All fields</td>
<td>Select this check box to repair all tables.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table.</td>
</tr>
<tr>
<td>Column</td>
<td>Select a column.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box if you want to deactivate this job.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the period between job executions.</td>
</tr>
<tr>
<td>Starting</td>
<td>Enter the date and time to run the job for the first time.</td>
</tr>
</tbody>
</table>

3. Click the menu icon in the form header and select **Save**.

4. To see an estimated count of records to be updated, click **Estimated Record Count**.

### Schedule a proxy-database recovery job

Run this job when the proxy database has lost data. This job finds all records that have been encrypted with a token (order preserving encryption type) and sends them to the proxy so that the proxy database can be rebuilt.

Role required: security_admin

1. Navigate to **Edge Encryption Configuration > Maintenance > Schedule Database Recovery**.
2. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for this job.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Select <strong>Database Recovery</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box if you want to deactivate this job.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the period between job executions.</td>
</tr>
<tr>
<td>Starting</td>
<td>Enter the date and time to run this job for the first time.</td>
</tr>
</tbody>
</table>

3. Click the menu icon in the form header and select **Save**.

4. To see an estimated count of records to be updated, click **Estimate Record Count**.

### Blacklist requests from an IP address in your network

Because the Edge Encryption proxy server resides in your network, it may be subject to vulnerability scans by your network software. To prevent IP scanner or other requests from being forwarded to your ServiceNow instance, you can blacklist IP addresses, IP ranges, or network masks. Any connection to the proxy server from a blacklisted address is terminated and is not forwarded to your instance.

Role required: security_admin

To blacklist an IP address, you must be logged in to your instance through the proxy server.
Important: Ensure that you understand your network topology before blacklisting IP addresses in your network. If an IP address is added to the blacklist, any user with that IP address will be blocked from accessing the Edge Encryption proxy server.

1. Navigate to **Edge Encryption Configuration > Maintenance > Blacklist IP Addresses.** The Encryption Proxy IP Blacklists [edge_encryption_ip_blacklist] list view opens.
2. Click **New.**
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proxy server</td>
<td>The Edge Encryption proxy server that is prevented from forwarding requests from blacklisted addresses.</td>
</tr>
<tr>
<td>IP, IP range, or net-mask</td>
<td>Requests from this IP address, range, or network mask are not forwarded to your ServiceNow instance. Example values include:</td>
</tr>
<tr>
<td></td>
<td>• IP address: 10.10.10.5</td>
</tr>
<tr>
<td></td>
<td>• IP range: 10.10.10.1-15</td>
</tr>
<tr>
<td></td>
<td>• Network mask: 10.10.10.0/24</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the record is active. Only IP addresses from active records are prevented from sending requests to the instance.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the blacklist record.</td>
</tr>
</tbody>
</table>

4. Click **Submit.**
5. Repeat these steps for all other proxies for which an IP address should be blacklisted.

The Edge Encryption proxy server terminates any connection from a blacklisted IP addresses, range, or network mask and cannot forward the request to the instance.

**Encrypt data from a record producer**

Record producers allow end users to create task-based records, such as incident records, from the Service Catalog and Service Portal. If a record producer attempts to insert data into a field marked for encryption, an invalid insert message displays and the data is not saved to the field. To configure your Edge Encryption proxy server to allow inserts from a record producer, create encryption rules from the record producer record.

Role required: security_admin

Encrypting data from a record producer requires an encryption configuration defined for the target field. Check that you have created an encryption configuration for the target field and table before creating an encryption rule from a record producer. See **Create an encryption configuration.** To encrypt attachments from a record producer, **Configure attachment encryption.**

1. Log in to your instance through the Edge Encryption proxy server.
2. Navigate to **Service Catalog > Catalog Definitions > Record Producers.**
3. **Create a record producer** record or open an existing record producer record.
Two inactive encryption rules are automatically created to encrypt data sent from the record producer to the field marked for encryption.

<table>
<thead>
<tr>
<th>Encryption rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;RecordProducerName&gt;</code></td>
<td>Rule created to process POST parameters from the Service Catalog and map variables to fields in the instance.</td>
</tr>
<tr>
<td><code>&lt;RecordProducerName&gt;Json</code></td>
<td>Rule created to process a JSON payload from the Service Portal and map variables to fields in the instance.</td>
</tr>
</tbody>
</table>

5. Activate the necessary encryption rules created by the record producer.
   a) Navigate to Edge Encryption Configuration > Rules > All.
   b) Depending on where the record producer will be used, open the associated encryption rule created by the record producer and select the Active flag.
      If using the record producer in the Service Catalog, activate the `<RecordProducerName>` encryption rule. If using the record producer in the Service Portal, activate the `<RecordProducerName>Json` encryption rule.
6. Optional: Examine the Encryption rule **Action** field and add any necessary field names or statements.

If a record producer directly maps a variable to a field in a table, the encryption rule automatically maps the variable to the correct field. However, if a variable is indirectly mapped through various scripts on the platform, you may need to update the rules to map each variable to the correct field.

The below encryption rule was created from the Report Outage record producer and processes POST parameters from the Service Catalog to map variables to fields in the instance. Replace `'FILL ME IN'` with the target field.
The below encryption rule was created from the Report Outage record producer and processes a JSON payload from the Service Portal to map variables to fields in the instance. Add additional statements to map any scripted variables to the target fields.
function ReportOutageAction(request) {
    var tableName = "INCIDENT";
    // Some fields are set in script, additional parameter lines may need to be added
    // current.comments is accessed via script from notes; // assignment to current.comments does NOT replace existing values
    // current.short_description is accessed via script from short_description;
    // current.description is accessed via script from current.short_description;
    // current.entity_id is accessed via script from getEntityId();
    var jsonElementsItr = request.getJSONObject('variables');
    while (jsonElementsItr.hasNext()) {
        var jsonElement = jsonElementsItr.next();
        jsonElement.setValueFor(tableName, jsonElement.getName());
    }
}
When the payload from the record producer is examined, the error_message element contains the value for the short_description field. By adding the following statement, you can map the scripted variable error_message to the short_description field.

```javascript
if (jsonElement.getName() == 'error_message')
    jsonElement.valueFor(tableName, 'short_description');
```

The value of the **Action** field becomes:

```javascript
function ReportOutageJsonAction(request) {
    var tableName = 'incident';
    // Some fields are set in script, additional parameter lines may need to be added
    // current.comments is accessed via script from notes; // assignment to current.comments does NOT replace existing values
    // current.short_description is accessed via script from short_description;
    // current.description is accessed via script from current.short_description;
    // current.caller_id is accessed via script from gs.getUserID();
    var jsonContent = request.getAsJsonContent();
    for (var jsonElementItr = jsonContent.getIterator('variables'); jsonElementItr.hasNext();)
        {
            var jsonElement = jsonElementItr.next();
            if (jsonElement.getName() == 'error_message')
                jsonElement.valueFor(tableName, 'short_description');
            else {
                jsonElement.valueFor(tableName, jsonElement.getName());
            }
        }
}
```

The two encryption rules enable the record producer to insert values into fields marked for encryption from either the Service Catalog or Service Portal.

**Define a custom encryption rule**

It may be necessary to identify and encrypt sensitive information in HTTP requests on the way to your instance. You can write encryption rules to identify, interpret, and encrypt data in such requests, mapping fields in the request to table-field names on your instance.

**What is an encryption rule**

Encryption rules are scripts executed on the Edge Encryption proxy server to map fields in a request to fields in a table on your ServiceNow instance. An encryption rule tells the Edge Encryption proxy server how to encrypt data in custom payloads.

**Note:** Encryption rules only support ECMAScript 3 and below.

**When to use custom rules**

A set of encryption rules is included as part of the Edge Encryption plugin. These rules handle core platform use cases such as editing a field from the list edit form, updating a record from the record form, managing direct web services, and processing data from the REST API. Applications created using standard forms and lists should work without custom encryption rules.
If you develop scripted processors, scripted web services, scripted REST APIs, UIs, or Ajax scripts that contain data that should be encrypted, you must write encryption rules to find and map the data to Glide table-field names.

**Format of an encryption rule**

Rules include three parts:

- **Condition**: Identifies the type of request.
- **Action**: Maps fields in the request to fields in a table, encrypting values that map to fields with encryption configurations defined.
- **Order**: Priority of the rule. The lowest priority rule with a satisfied condition is the only rule that runs. Like business rules, rules run from lowest to highest.

Except for attachment requests, when an HTTP request hits the Edge Encryption proxy server, the Edge Encryption proxy server evaluates all encryption rule conditions in priority order until either all conditions return false, or one condition returns true. When a condition returns true, the action is executed on the request and the result is forwarded to the instance. No other conditions are evaluated. As a result, encryption rule conditions should be as specific as possible. A generic rule might evaluate as true for a request meant to be processed by another rule, causing the request to be processed by the wrong action. If a generic condition is unavoidable, the rule should be marked with a high-order value so that more specific rules are evaluated first.

**Guidelines for creating encryption rules**

Creating efficient, optimized encryption rules can reduce processing time for script validation.

**Overall guideline**: When rules get very long, do your best to minimize the number of blocks and break the rules apart whenever possible. Ideally, custom rules should apply to specific use cases, rather than encompassing several cases, with if statements in the action script.

1. Split rules whenever possible. For example,
   - Create different rules for different tables and ensure that each rule runs only on its respective table.
   - Create different rules for each record producer you are targeting, or at least for each subset of record producers. Instead of one rule targeting dozens of sys_ids, you could create several different rules targeting smaller subsets of record producers, or even create one rule per sys_id.

   **Note**: Creating multiple rules requires more maintenance. The trade-off is that multiple, simpler rules can be validated more efficiently than longer, more complex rules.

2. Minimize the number of blocks. Because the processing engine scans each block while evaluating scripts, a large number of blocks causes delays in validation. For example,
   - Replace all if blocks with an array lookup, and replace all blocks in the array lookup with just one if block.
   - Combine if blocks whenever it is possible to group them.
Encryption rule APIs

Encryption rules are written in JavaScript and utilize Edge Encryption APIs to locate and encrypt sensitive information in the body of a request. The API uses expressions similar to xPath to navigate through both JSON and XML content.

Edge Encryption APIs process the request off the stream as it is being written to the output stream. Stream parsing allows encryption rules to be network performant. However, fetching and parsing content from the body multiple times could lead to unexpected results. To account for this, requests should be processed by the action in a single pass.

When creating encryption rules, you cannot use Glide APIs, script includes, business rules, or any global parameters such as current. Because the rules are created for HTTP objects, a global request object is available.

When creating encryption rules, you cannot use APIs from the white list manager or scoped applications.

Error handling

If an encryption rule condition or action throws an exception, check the proxy log for troubleshooting information.

Inspect the client request

Before creating a custom encryption rule, you must determine the format of the client request entering the Edge Encryption proxy server.

Because encryption rules iterate over client requests and determine what, if anything, needs to be encrypted, you must understand the type of request you are creating a rule for. The format of the client request determines the structure of your encryption rule and the APIs available for use in the rule.

1. Inspect the client request.

   Depending on the source of the request, the following tools are available to inspect the request and determine the format.

<table>
<thead>
<tr>
<th>Source of request</th>
<th>Available tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client browser</td>
<td>Use the developer console in your browser to inspect the client request. Useful tools include:</td>
</tr>
<tr>
<td></td>
<td>• Firefox Network Monitor</td>
</tr>
<tr>
<td></td>
<td>• Chrome Network Panel</td>
</tr>
<tr>
<td>Third-party/external source</td>
<td>Use an HTTP protocol analyzer to inspect the request. Useful tools include:</td>
</tr>
<tr>
<td></td>
<td>• Wireshark</td>
</tr>
<tr>
<td></td>
<td>• HTTP Scoop</td>
</tr>
<tr>
<td></td>
<td>Alternatively, you can often use documentation for the external source to</td>
</tr>
<tr>
<td></td>
<td>determine the format of the request.</td>
</tr>
</tbody>
</table>

2. From the client request, inspect the packet and determine:
   - The client request method
   - The URL path of the request
   - The URL parameters
- The POST parameters, if any
- The format of the request body, if included

Inspecting the request provides an understanding of the fields you need to filter for and iterate over in your encryption rule. To understand the fields in the request object, see request.

**Create an encryption rule**

Encryption rules are used by the proxy to find content in HTTP requests that should be encrypted.

Role required: security_admin

Before creating an encryption rule, you must Inspect the client request to determine the format.

To create or edit encryption rules, you must be connected to the instance through an encryption proxy.

1. Navigate to Edge Encryption Configuration > Rules > Create New.
2. In the Name box, enter a name.
3. In the Request Type, select an HTTP method.
   - HTTP Post
   - HTTP Get
   - HTTP Put
   - HTTP Patch
   - HTTP Delete

   **Note:** Pre-Jakarta instances allow only HTTP Get and HTTP Post methods.

4. In the Condition box, enter a JavaScript statement defining when the rule should run.
5. In the Action box, enter a JavaScript function to be executed when the condition is true.
6. In the Order box, enter the relative priority of the rule.
7. Click Submit, or save the form.

**Encryption rule conditions**

Encryption rule conditions determine if the rule should be executed.

An encryption rule condition must return true if the rule is to handle the HTTP request; otherwise, it must return false.

As you build your condition, keep in mind that only one rule is executed per request. As a result, the condition must be as general or specific as needed to run under the intended circumstances.
Note: Be careful when performing checks on content in the condition. Excessive checks can be expensive for the proxy server and may cause increased latency when handling complex requests.

The condition can use the method type, content type, URL path, or any URL query string parameters to determine if the rule should handle the request. The condition has access to these fields via the request object. Be sure that, prior to creating an encryption rule condition, you have inspected the client request and understand the conditions needed to trigger the rule.

Note: To build efficient rules, consider easy ways to rule out requests that you do not want to be evaluated by a rule. Build your condition to return false for those requests first. This method increases performance and quickly routes the request to the correct rule faster.

Encryption rule objects and APIs are available to encryption rule conditions.

Example using path and postParams

```javascript
/*This condition checks if the request coming in has a path ending in "/sample_processor.do" and if a post parameter exists in that request called myPostParam */

function SampleCondition(request) {
    if (endsWith(request.path, "/sample_processor.do") &&
        request.postParams.myPostParam) {
        return true;
    } else {
        return false;
    }
}
```

Example using urlParams and contentType

```javascript
/* This condition checks if a url parameter exists in the query called myUrlParam and if the content type contains 'xml' (if so, you can expect the body to be an XML payload). Then, it checks if the xml payload contains myXmlTag */

function SampleCondition2(request) {
    if (request.urlParams.myUrlParam && request.contentType.indexOf('xml') > -1 &&
        request.xmlContains('myXmlTag')) {
        return true;
    } else {
        return false;
    }
}
```

Encryption rule actions

An encryption rule maps fields in a client request to fields in a table on your instance and identifies fields marked for encryption.

An encryption rule action only runs when the encryption rule condition returns true. An encryption rule identifies the data to be encrypted in your request payload. Because the rule iterates over the content in the request object, you must understand the form and structure of your request body and determine what in the request needs to be encrypted. The data to be encrypted might be located within:

- A POST or URL parameter.
- JSON or XML content within a POST or URL parameter.
• A JSON payload.
• An XML payload.

Before writing an encryption rule action, be sure to:
• Inspect the client request.
• Identify where the sensitive data is located in the request object.
• Determine the field and table name to insert data into, or understand how to dynamically pull this from the request.

Encryption rule objects and APIs are available to encryption rule actions and conditions.

Encryption rule objects and APIs

Use encryption rule APIs to parse and encrypt values in requests moving through the Edge Encryption proxy server to the instance.

The APIs available for your encryption rule depend on the format of the request object. For example, if the contentType parameter of the request object is XML, you can use the XML APIs to parse and encrypt values in the payload. After you determine the type of object in your request, you can build an encryption rule using the available APIs.

Encryption rule APIs are available in both encryption rule condition and action scripts.

request

The request object is a global object available in Edge Encryption rule action and condition scripts.

The request object is a JavaScript object that represents the client request coming in to the Edge Encryption proxy server. You must build your encryption rule to parse the request object, map request object values to fields in a table on the instance, and encrypt any sensitive data in the request object.

The request object includes the following attributes and data from the client request:

Request object fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>path</td>
<td>The path portion of the URL.</td>
</tr>
<tr>
<td>requestMethod</td>
<td>GET, POST, PUT, PATCH, DELETE.</td>
</tr>
<tr>
<td>contentType</td>
<td>The Content-Type header field.</td>
</tr>
<tr>
<td>urlParams</td>
<td>The parameters in the query string. This can also be evaluated to a String.</td>
</tr>
<tr>
<td>postParams</td>
<td>If this is a form post, this contains the post parameters.</td>
</tr>
</tbody>
</table>

request - getAsJsonContent()

Returns the request as an iterable object of type JsonNode.

This method is available only in an Edge Encryption rule if the request body is a valid JSON payload. If you are not sure what format the request body includes, check the contentType field on the request object.

Once the request is returned as a JsonNode object, you can use the JSON APIs to iterate over the object and encrypt fields.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JsonNode</td>
<td>The request as an iterable JsonNode.</td>
</tr>
</tbody>
</table>

request - getAsXmlContent()

Returns the request content as an iterable object of type XMLContent.

This method is available only in an Edge Encryption rule if the request body is a valid XML payload. If you are not sure what format the request body includes, check the contentType field on the request object. Once the request is returned as an XMLContent object, you can use the XML APIs to iterate over the object and encrypt fields.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMLContent</td>
<td>The request as an iterable object of type XMLContent.</td>
</tr>
</tbody>
</table>

request - XMLContains(String path)

Returns true if the given path exists in the XML DOM.

This method is available only if the request body is a valid XML payload. If you are not sure what format the request body includes, check the contentType field on the request object.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>path</td>
<td>String</td>
<td>XPath statement you are searching for.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>Whether the given path exists in the XML DOM.</td>
</tr>
</tbody>
</table>
**POST and URL parameter APIs**

POST and URL parameters can be accessed as properties of the `request` object using `request.postParams` and `request.urlParams`.

Any single parameter can be accessed as a property of the `postParams` and `urlParams` parent objects by calling `request.postParams.myParam`. Any parameter accessed this way is an object of the underlying class `ParameterValue`. Any APIs in this class can be called on any parameter.

After inspecting the client request, it may be necessary to access and encrypt parameter values from the `request` object. Depending on the data in the client request, you can encrypt values and map them to fields on the instance in multiple ways.

**Encrypt the value of a known table and field**

If you know the name of the instance table and field that will hold the encrypted data, you can explicitly define them in the encryption rule. For example, you may know that the request will be processed on the instance to create an incident and you want to encrypt the `text` parameter in the description field. In this case, you can create the following action.

```javascript
function SampleAction1() {
    request.postParams.text.valueFor('incident', 'description');
}
```

**Encrypt the value of a dynamically defined table and field**

If, conversely, you do not know the name of the field that the encrypted data will populate, you can dynamically define them using `tableName` and `fieldName`.

The below example processes a generic request that might store data in different task tables (such as incident, problem, and change_request) on the instance.

```javascript
function SampleAction2() {
    var tableName = request.urlParams.table;
    for (var parameter in request.postParams) {
        var currentParam = request.postParams[parameter];
        var fieldName = currentParam.toString();
        if (fieldName == 'text') {
            currentParam.valueFor(tableName, 'description');
        } else {
            currentParam.valueFor(tableName, fieldName);
        }
    }
}
```

This action:

- Gets the destination table from the URL parameters.
- Iterates over the URL parameters.
- Asks the Edge Encryption proxy server to encrypt any URL parameter with a name that matches a field marked for encryption.
- Looks for a specific parameter called `text` and asks the Edge Encryption proxy to encrypt the value based on the encryption configuration for the description field on the incident table.

In this example, the `valueFor()` method is not actually performing any encryption. Rather, the method asks the Edge Encryption proxy server to check whether the table/field pair in the request object is marked for encryption with an encryption configuration and, if applicable, encrypt it.
Encrypt JSON or XML within a parameter

A POST or URL parameter might include JSON or XML content. In this case, you can process the content within the parameter, iterate over the values, and encrypt required fields. In this example, the `tableName` is still accessed from a POST parameter, but the value of the field is the JSON object `data`.

```javascript
function SampleAction3() {
    var tableName = request.postParams.table;
    var data = request.postParams.data;
    var dataIterator = data.getAsJsonContent().iterator();
    while (dataIterator.hasNext()) {
        var jsonElement = dataIterator.next();
        var fieldName = jsonElement.getName();
        if (fieldName == 'text') {
            jsonElement.valueFor(tableName, 'description');
        } else {
            jsonElement.valueFor(tableName, fieldName);
        }
    }
}
```

An example of an encryption rule action that processes XML within a POST parameter.

```javascript
function SampleAction4() {
    var tableName = request.postParams.table;
    var data = request.postParams.data;
    var dataIterator = data.getAsXmlContent().getIteratorOverAllChildren();
    while (dataIterator.hasNext()) {
        var jsonElement = dataIterator.next();
        var fieldName = jsonElement.getName();
        if (fieldName == 'text') {
            jsonElement.valueFor(tableName, 'description');
        } else {
            jsonElement.valueFor(tableName, fieldName);
        }
    }
}
```

Encrypt a query

You might encounter an encoded query within a parameter in the client request that contains sensitive data. To match a field in a query to an encrypted value in the instance database, you must create an encryption rule that asks the proxy to check whether a field in the query is marked for encryption. The `encodedQueryFor()` method parses an encoded query on a given table, and checks if any fields in the query have encryption configurations.

In this example, the rule iterates over the parameters looking for the `filter` parameter, which is expected to be a Glide encoded query.

```javascript
function SampleAction5() {
    for (var parameter in request.postParams) {
        var currentParam = request.postParams[parameter];
        var fieldName = currentParam.toString();
        if (fieldName == 'filter') {
            currentParam.encodedQueryFor(tableName);
        } else {
            currentParam.valueFor(tableName, fieldName);
        }
    }
}
```
For example, if the value of filter is: short_description=My sensitive information^number=INC000056^category=Outage, the query would become short_description=<Encrypted(My sensitive information)>^number=INC000056^category=Outage on the instance.

ParameterValue - toString()
Converts the POST or URL parameter value to a string.

| Parameters |
| Name | Type | Description |
| None | | |

Returns

| Type | Description |
| String | The parameter value as a string. |

ParameterValue - getAsJsonContent()
Returns the request as an iterable object of type JsonNode.

This method is available only in an Edge Encryption rule if the request body is a valid JSON payload. If you are not sure what format the request body includes, check the contentType field on the request object.

Once the request is returned as a JsonNode object, you can use the JSON APIs to iterate over the object and encrypt fields.

| Parameters |
| Name | Type | Description |
| None | | |

Returns

| Type | Description |
| JsonNode | The request as an iterable JsonNode. |

ParameterValue - getAsXmlContent()
Returns the request content as an iterable object of type XMLContent.

This method is available only in an Edge Encryption rule. This method assumes that the request body is a valid XML payload. You can check the contentType to make sure.

Once the request is returned as an XMLContent object, you can use the XML APIs to iterate over the object and encrypt fields.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMLContent</td>
<td>The request as an iterable object of type XMLContent.</td>
</tr>
</tbody>
</table>

ParameterValue - encodedQueryFor(String tableName)

Specifies that the value of the element is an encoded query on the specified table.

Calling this function on a parameter tells the proxy that the value of the parameter is an encoded query for the specified table. The proxy parses the encoded query and encrypts the fields in the encoded query that must be encrypted.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tableName</td>
<td>String</td>
<td>The table that you expect the query to run on.</td>
</tr>
</tbody>
</table>

ParameterValue - valueFor(String tableName, String fieldName)

Specifies that the value of the element maps to the specified field in the specified table.

Calling this method on an element value tells the proxy that the value for this element maps to the specified field in the specified table. The proxy then checks if the field must be encrypted.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tableName</td>
<td>String</td>
<td>The table name.</td>
</tr>
<tr>
<td>fieldName</td>
<td>String</td>
<td>The field name.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>
**XML APIs**

XML APIs can be used after calling `getAsXmlContent()` on either the request object or a ParameterValue property.

When using XML APIs to write your encryption rule, you can follow a general format:

1. Call `getAsXmlContent()` on the request object or ParameterValue property. This returns an iterable object of the XMLContent underlying class.

2. Call `getIterator()` or `getIterator(String xPath)` on the XMLContent object. This returns an XMLElementIterator object that can be used to iterate over XML elements.

3. Call the `hasNext()` method on the XMLElementIterator object to determine whether another element is available.

4. Call `next()` on the XMLElementIterator object to return the next XML element. You cannot call `next()` without first calling `hasNext()`.

5. Call `valueFor(String tableName, String fieldName)` on the XML element. This method tells the proxy that the value for this element maps to the specified field in the specified table. The proxy then checks if the field must be encrypted.

**Note:** To determine if you want to call `valueFor(String tableName, String fieldName)` on an XML element, you can use the `getName()` method to return the name of the element.

### Mapping to a known table-field on the instance

In this example, the XML payload will be processed on the instance to insert records in the incident table. The description field will populate short_description on the incident.

```xml
<data>
  <record>
    <name>'Test Record 1'</name>
    <description>'Test Record 1 Description'</description>
    <tag>critical</tag>
  </record>
  <record>
    <name>'Test Record 2'</name>
    <description>'Test Record 2 Description'</description>
    <tag>security</tag>
  </record>
</data>
```

The following encryption rule action can apply:

```javascript
function sampleXmlAction1() {
  var xmlContent = request.getAsXmlContent();
  // This loop iterates over all description tags that match the given path
  var xmlElementIterator = xmlContent.getIterator('data/record/description');
  while (xmlElementIterator.hasNext()) {
    var xmlElement = xmlElementIterator.next();
    xmlElement.valueFor('incident', 'short_description');
  }
}
```
This action iterates through the `description` tags and asks the proxy server to encrypt the values and insert them into `incident.short_description` on the instance.

**Note:** This rule finds all `description` tags within all `record` tags in the XML payload. If there is only one occurrence of a tag to encrypt, the rule still uses the XPath and iterator structure. However, it iterates only once in the loop.

**Mapping to an unknown table-field on the instance**

In this example, the rule iterates over the `record` tags, but does not know what tags to expect within the `record` tag. The only known is that the tags within the `record` tags match the names of the columns specified in the table URL parameter.

The rule also specifies that, if the table is `incident`, then the data in the `description` tag should be encrypted and stored in the `short_description` field on the instance.

```javascript
function sampleXmlAction2() {
    var xmlContent = request.getAsXmlContent();
    var tableName = request.urlParam.table;
    // This first iterator will iterate over all record elements
    var xmlElementIterator = xmlContent.getIterator('data/record');
    while (xmlElementIterator.hasNext()) {
        encryptFieldsInRecord(xmlElementIterator.next());
    }
}

function encryptFieldsInRecord(xmlElement) {
    // Then, iterate over all tags representing fields in the table
    var fieldIterator = xmlElement.getIteratorOverAllChildren();
    while (fieldIterator.hasNext()) {
        var field = fieldIterator.next();
        var fieldName = childElement.getName();
        // if table is incident, then description is encrypted for the short_description field
        if (tableName == 'incident' && fieldName == 'description') {
            field.valueFor(tableName, 'short_description');
        } else {
            // if table is not incident, ask the proxy to check if the given field is encrypted for the given table
            field.valueFor(tableName, fieldName);
        }
    }
}
```

In the `encryptFieldsInRecord()` function, the `valueFor()` method is called on a table and a field that are dynamically assigned based on the request. Even though the table and field names can change, the rule asks the proxy to check whether the field in the table must be encrypted based on the encryption configurations defined.

If the field is not configured for encryption, or if the tag does not match a field in the table, the proxy skips that tag. If the tag matches a field marked for encryption, then the Edge Encryption proxy server encrypts the value.
Using an encoded query

In this example, all tags have the `filter` attribute, which indicates whether the tag contains an encoded query.

```xml
<data>
  <record>
    <name filter="false">'Test Record 1'</name>
    <description filter="false">'Test Record 1 Description'</description>
    <query filter="true">category=1^name=edge</query>
  </record>
  <record>
    <name filter="false">'Test Record 2'</name>
    <description filter="false">'Test Record 2 Description'</description>
    <query filter="true">category=2^severity=3</query>
  </record>
</data>
```

The following encryption rule action can apply:

```javascript
function sampleXmlAction3() {
    var xmlContent = request.getAsXmlContent();
    var tableName = request.urlParam.table;
    // This first iterator will iterate over all record elements
    var xmlElementIterator = xmlContent.getIterator('data/record');
    while (xmlElementIterator.hasNext()) {
        encryptFieldsInRecord(xmlElementIterator.next());
    }
}

function encryptFieldsInRecord(xmlElement) {
    // this time we want to iterate over all tags representing fields in the table
    var fieldIterator = xmlElement.getIteratorOverAllChildren();
    while (fieldIterator.hasNext()) {
        var field = fieldIterator.next();
        var fieldname = childElement.getName();
        // let's look at the filter attribute, if true, then encrypt as encoded query
        if (field.getAttributeValue('filter') == 'true') {
            field.encodedQueryFor(tableName);
        } else {
            // if it is false then check if the field should be encrypted
            field.valueFor(tableName, fieldName);
        }
    }
}
```

If the `filter` attribute value is true, the rule asks the proxy server to encrypt the values in the encoded query. If false, the rule asks the proxy to check whether the field should be encrypted.

**XMLContent**

A global object that provides methods to iterate over the XML content.

You can access an `XMLContent` object by calling `getAsXmlContent()` on a `request` object.

You access XML data in a POST or URL parameter by calling `request.postParams.<parameter name>.getAsXmlContent()` or `request.urlParams.<parameter name>.getAsXmlContent()`.

**XMLContent - getIterator()**

Returns an `XMLElementIterator` object for the XML content.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMLContent</td>
<td></td>
</tr>
</tbody>
</table>

XMLElementIterator

Provides methods for iterating over XML elements.

You get an `XMLElementIterator` object by calling the `getIterator()` method of the `XMLContent` class.

XMLElementIterator - hasNext()

Determines if there is another element available.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>True if another element is available.</td>
</tr>
</tbody>
</table>

XMLElementIterator - next()

Returns the next element in the iterator.
You cannot call `next()` without first calling `hasNext()`.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMLElement</td>
<td>The next XML element.</td>
</tr>
</tbody>
</table>

**XMLElement**

Provides methods for iterating through XML elements and mapping values to fields in a table.

You get an `XMLElement` object by calling the `next()` method of an `XMLElementIterator` object.

**XMLElement - getIterator(String xPath)**

Returns an `XMLElementIterator` object for the XML element based on the specified parameter.

#### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>xPath</td>
<td>String</td>
<td>An xPath-like expression that specifies where in the <code>XMLElement</code> object to start.</td>
</tr>
</tbody>
</table>

#### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMLElementIterator</td>
<td>An object that can be used to iterate over elements in the <code>XMLElement</code> object.</td>
</tr>
</tbody>
</table>

**XMLElement - getIteratorOverAllChildren()**

Returns an `XMLElementIterator` object that includes all sub-elements for the XML element based on the specified parameter.

#### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMLElementIterator</td>
<td>An object that can be used to iterate over elements in the <code>XMLElement</code> object.</td>
</tr>
</tbody>
</table>
**XMLElement - valueFor(String tableName, String fieldName)**

Specifies that the value of the element maps to the specified field in the specified table.

Calling this method on an element value tells the proxy that the value for this element maps to the specified field in the specified table. The proxy then checks if the field must be encrypted. If the table and field names are unknown, you can call the `valueFor()` method on a table and a field that are **dynamically assigned** based on the request.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tableName</td>
<td>String</td>
<td>The table name.</td>
</tr>
<tr>
<td>fieldName</td>
<td>String</td>
<td>The field name.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

**XMLElement - encodedQueryFor(String tableName)**

Specifies that the value of the element is an encoded query for the specified table.

Calling this function on an element tells the proxy that the value of the element is an **encoded query** for the specified table. The proxy parses the encoded query and encrypts the fields in the encoded query that must be encrypted.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tableName</td>
<td>String</td>
<td>The table that you expect the query to run on.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

**XMLElement - getName()**

Returns the element name.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The element name.</td>
</tr>
</tbody>
</table>

XMLElement - `getAttributeValue(String attribute)`

Returns the value of the specified attribute.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>attribute</td>
<td>String</td>
<td>Attribute name.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The attribute value.</td>
</tr>
</tbody>
</table>

JSON APIs

JSON APIs can be used after calling `getAsJsonContent()` on either the `request` object or a `ParameterValue` property.

When using JSON APIs to write your encryption rule, you can follow a general format:

1. Call `getAsJsonContent()` on the `request` object. This returns an iterable object of the `JsonNode` underlying class.
2. Call `getIterator()` or `getIterator(String xPath)` on the `JsonNode` object. This returns a `JsonNodeIterator` object that can be used to iterate over nodes in the JSON object.
3. Call the `hasNext()` method on the `JsonNodeIterator` object to determine whether another element is available.
4. Call `next()` on the `JsonNodeIterator` object to return the next JSON element. You cannot call `next()` without first calling `hasNext()`.
5. Call `valueFor(String tableName, String fieldName)` on the JSON element. This method tells the proxy that the value for this element maps to the specified field in the specified table. The proxy then checks whether the field must be encrypted.

Note: To determine if you want to call `valueFor(String tableName, String fieldName)` on a JSON element, you can use the `getName()` method to return the name of the element.

Mapping to a known table-field on the instance

In this example, the JSON payload is processed on the instance to insert records in the incident table. The description field populates `short_description` on the incident.

```json
{
    data: {
        records: [
```
The following rule can apply:

```javascript
function sampleJsonAction1() {
  var jsonContent = request.getAsJsonContent();
  // This loop iterates over all description elements in the records array
  var jsonNodeIterator = jsonContent.getIterator('/data/records/description');
  while (jsonNodeIterator.hasNext()) {
    var jsonNode = jsonNodeIterator.next();
    jsonNode.valueFor('incident', 'short_description');
  }
}
```

This action iterates through the `description` nodes and asks the proxy server to encrypt the values and insert them into `incident.short_description` on the instance.

**Note:** This rule finds all `description` nodes within the JSON payload. If there is only one occurrence of a node to encrypt, the rule still uses the xPath and iterator structure. However, it iterates only once in the loop.

### Mapping to an unknown table-field on the instance

In this example, the rule iterates over `records`, but is not sure what nodes to expect. The only known is that for each object within `records`, the nodes match the names of the columns specified in the table URL parameter.

The rule also specifies that, if the table is incident, then the data in the `description` node should be encrypted and stored in the `short_description` field on the instance.

```javascript
function sampleJsonAction2() {
  var jsonContent = request.getAsJsonContent();
  var tableName = request.urlParam.table;
  // This first iterator will iterate over all record elements
  var jsonNodeIterator = jsonContent.getIterator('data/records');
  while (jsonNodeIterator.hasNext()) {
    encryptFieldsInRecord(jsonNodeIterator.next());
  }
}

function encryptFieldsInRecord(jsonNode) {
  // this time we want to iterate over all nodes
  var fieldIterator = jsonNode.iterator();
  while (fieldIterator.hasNext()) {
    var field = fieldIterator.next();
  }
}
```
In the encryptFieldsInRecord() function, the valueFor() method is called on a table and a field that are dynamically assigned based on the request. Even though the table and field names can change, the rule asks the proxy to check whether the field in the table must be encrypted based on the encryption configurations defined.

If the field is not configured for encryption, or if the node name does not match a field in the table, the proxy skips that node. If the node name matches a field marked for encryption, then the proxy encrypts the value.

**Using an encoded query**

```javascript
function sampleJsonAction3() {
    var jsonContent = request.getAsJsonContent();
    var tableName = request.urlParam.table;
    // This first iterator will iterate over all record elements
    var jsonNodeIterator = jsonContent.getIterator('data');
    while (jsonNodeIterator.hasNext()) {
        var jsonNode = jsonNodeIterator.next();
        if (jsonNode.getName() == 'records')
            encryptRecords(jsonNodeIterator.next());
        else if (jsonNode.getName() == 'query')
            jsonNode.encodedQueryFor(tableName);
    }
    function encryptRecords(jsonNode) {
        //we iterate over all fields in the node
        var recordIterator = jsonNode.iterator();
        while (recordIterator.hasNext()) {
            encryptFieldsInRecord(recordIterator.next());
        }
    }
    function encryptFieldsInRecord(jsonNode) {
        //this time we want to iterate over all nodes
        var fieldIterator = jsonNode.iterator();
        while (fieldIterator.hasNext()) {
            var field = fieldIterator.next();
            var fieldname = childElement.getName();
            field.valueFor(tableName, fieldname);
        }
    }
}
```

In this example, the rule iterates over data. As it finds records, it performs the same logic as in the second example, iterating over fields in each node. When it finds the query node, it calls encodedQueryFor() to encrypt values that should be encrypted in the query.

**JsonNode**

A global object that provides methods to iterate over the JSON content.

You can access a JsonNode object by calling getAsJsonContent() on a request object.

You access JSON content from a POST or URL parameter by calling request.postParms.<parameter name>.getAsJsonContent() or request.urlParms.<parameter name>.getAsJsonContent().
JsonNode - getIterator(String xPath)
Returns a JsonNodeIterator object for the JSON content.
This method can only be used on the root node, but can be used to traverse deep into the JSON object. Subsequent traversals must use the iterator() method.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>xPath</td>
<td>String</td>
<td>An xPath expression.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JsonNodeIterator</td>
<td>An object that can iterate over nodes in the JSON object.</td>
</tr>
</tbody>
</table>

JsonNode - iterator()
Returns a JsonNodeIterator object that iterates over all child nodes of the current node.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JsonNodeIterator</td>
<td>An object that can iterate over nodes in the JSON object.</td>
</tr>
</tbody>
</table>

JsonNode - getAsString()
Returns the current node value as a string.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The current node value.</td>
</tr>
</tbody>
</table>

JsonNode - getAsString(String propertyName)
Returns the string value of the specified property.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>propertyName</td>
<td>String</td>
<td>Name of the property.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The property value.</td>
</tr>
</tbody>
</table>

JsonNode - getName()

Returns the name of the current JSON node.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Name of the current JSON node.</td>
</tr>
</tbody>
</table>

JsonNode - valueFor(String tableName, String fieldName)

Specifies that the JSON property maps to the specified field in the specified table.

Calling this method on a JSON property tells the proxy that the value for this property maps to the specified field in the specified table. The proxy then decides if the field must be encrypted. If the table and field names are unknown, you can call the valueFor() method on a table and a field that are dynamically assigned based on the request.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tableName</td>
<td>String</td>
<td>The table name.</td>
</tr>
<tr>
<td>fieldName</td>
<td>String</td>
<td>The field name.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

JsonNode - encodedQueryFor(String tableName)

Specifies that the value of the JSON property is an encoded query for the specified table.
Calling this function on a JSON node tells the proxy that the value is an encoded query for the specified table. The proxy parses the encoded query and encrypts the values for fields in the encoded query that must be encrypted.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tableName</td>
<td>String</td>
<td>The table that you expect the query to run on.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

**JsonNodeIterator**

You get a `JsonNodeIterator` object by calling the `getIterator()` or `iterator()` methods of the `JsonNode` class.

**JsonNodeIterator - hasNext()**

Determines if there is another property available.

<table>
<thead>
<tr>
<th>Parameters</th>
<th></th>
</tr>
</thead>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>True if another property is available.</td>
</tr>
</tbody>
</table>

**JsonNodeIterator - next()**

Returns the next property in the iterator.

You cannot call `next()` without first calling `hasNext()`.

<table>
<thead>
<tr>
<th>Parameters</th>
<th></th>
</tr>
</thead>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JsonNode</td>
<td>The next JsonNode.</td>
</tr>
</tbody>
</table>
print(String message)
Prints a message to the wrapper log file: <proxy server directory>/logs/wrapper_<date>.log.

This method is available only in an Edge Encryption rule action script.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>message</td>
<td>String</td>
<td>The message to be written to the wrapper log file.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

Prohibited keywords

The Edge Encryption proxy validates encryption rule scripts before saving the rule. Many JavaScript keywords are not allowed in encryption rule scripts.

Prohibited keywords

<table>
<thead>
<tr>
<th>Keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DIR</strong></td>
</tr>
<tr>
<td><strong>FILE</strong></td>
</tr>
<tr>
<td><strong>LINE</strong></td>
</tr>
<tr>
<td><strong>parent</strong></td>
</tr>
<tr>
<td><strong>proto</strong></td>
</tr>
<tr>
<td>Error</td>
</tr>
<tr>
<td>eval</td>
</tr>
<tr>
<td>getClass</td>
</tr>
<tr>
<td>getPrototypeOf</td>
</tr>
<tr>
<td>Java</td>
</tr>
<tr>
<td>javax</td>
</tr>
<tr>
<td>javafx</td>
</tr>
<tr>
<td>JavaImporter</td>
</tr>
<tr>
<td>load</td>
</tr>
<tr>
<td>loadWithNewGlobal</td>
</tr>
<tr>
<td>new</td>
</tr>
<tr>
<td>Packages</td>
</tr>
<tr>
<td>Object</td>
</tr>
<tr>
<td>prototype</td>
</tr>
</tbody>
</table>
**Edge Encryption dictionary attributes**

You can add Edge Encryption dictionary attributes to tables and fields.

To set an Edge Encryption dictionary attribute to true, you must enter `attribute=true` in the Attributes field. To add a dictionary attribute to a record, see #unique_801.

**Edge Encryption Excluded [edge_encryption_excluded]**

When set to true, the field or table cannot be encrypted.

- Value: true/false
- Target element: field or table
- Default value: false

**Edge Encryption Enabled [edge_encryption_enabled]**

When set to true, the field is eligible for encryption through an encryption configuration. Because this attribute is used by the system and cannot be modified, it is not always displayed to the user.

> Note: This attribute does not indicate that a field is encrypted, nor does it trigger any encryption logic on the field. Rather, the attribute determines the possibility of the field being encrypted by a user.

- Value: true/false
- Target element: field
- Default value: true for String fields

**Edge Encryption Clear Text Allowed [edge_encryption_clear_text_allowed]**

When set to true, allows server-side scripts to append non-encrypted data to an encrypted string within the field for user actions performed through the proxy server, or any server-side automated scripts, such as scheduled jobs.

- Value: true/false
- Target element: field
- Default value: false

**Domain separation in Edge Encryption**

Edge Encryption provides the ability to encrypt data from within the customer's environment through the use of specific configurations, rules, and keys defined on the Edge Encryption proxy. The Edge Encryption proxy is not domain aware and cannot support domain-specific settings. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.
Overview

Support: Data only

Domain separation in this application is supported at the **Data only** level, meaning it supports the data security model of separating visibility of data from one domain to another. To learn more, see Application support for domain separation.

How domain separation works in Edge Encryption

Edge Encryption can be used where domain-specific keys, configurations, and rules are not required.

Data integration with Edge Encryption

To integrate third-party data with an instance using Edge Encryption, you must route the data through the Edge Encryption proxy server using supported integrations. Supported integrations use base system encryption rules that map data in each payload to fields in a table.

Upload data to fields marked for encryption

Edge Encryption does not support importing data from or exporting data to Excel, CSV, XML, or other file types to or from fields with encryption configurations defined.

**ODBC driver**

Encrypt requests and query data through the Edge Encryption proxy server using the ODBC driver.

Learn more: Edge Encryption ODBC driver integration

**MID Server**

You can configure the MID Server to route data through an Edge Encryption proxy server. However, some restrictions apply.

Learn more: Edge Encryption MID Server integration

**REST/SOAP web services**

Use REST/SOAP web services to update or retrieve record data through the Edge Encryption proxy server.

Learn more: #unique_803

**JSONv2 web service**

Use JSONv2 web service APIs to update or retrieve record data through the Edge Encryption proxy server. Base system encryption rules support data retrieval and data modification APIs.

- To insert a single record using the data modification API, use the `insert()` or `insertMultiple()` methods.
- To insert multiple records using the data modification API, use the `insertMultiple()` method.

Learn more: #unique_804

To encrypt data from custom third-party integrations not listed above, create custom encryption rules. See Define a custom encryption rule.
Upload attachments to records marked for encryption

Attachments can be uploaded to tables with attachment encryption configured using REST and SOAP web services.

Edge Encryption ODBC driver integration

Configure your ODBC driver to query data encrypted by Edge Encryption. The Edge Encryption proxy server encrypts ODBC driver requests to the ServiceNow instance when Edge Encryption is integrated with the ODBC driver.

Encrypted responses from the instance are decrypted through the Edge Encryption proxy server before passing to the ODBC driver in your network.
For a successful integration, the ODBC driver must trust the Edge Encryption proxy server certificate. If the Edge Encryption proxy server certificate is signed by a Certificate Authority trusted by the ODBC driver, the Edge Encryption proxy server is automatically trusted. However, if a Certificate Authority trusted by the ODBC driver has not signed the Edge Encryption proxy server certificate, you must import the self-signed certificate to the ODBC truststore.
**Import a self-signed certificate to the ODBC truststore**

If a Certificate Authority trusted by the ODBC driver has not signed the Edge Encryption proxy server certificate, you must import a self-signed certificate to the ODBC truststore. You can export the certificate from the Edge Encryption proxy server and import it into the ODBC truststore.

To determine whether a Certificate Authority trusted by the ODBC driver has signed the Edge Encryption proxy server certificate, run the following command in the keystore directory in the proxy home directory to view a list of Certificate Authorities trusted by the ODBC driver:

```
keytool -keystore "<ODBC directory>\ip\Java\jre\lib\security\cacerts" -list
```

1. Change to the keystore directory in the proxy home directory.
2. Check the keystore for the self-signed certificate.
   a) To check the keystore for the certificate, you can run the following command to list all the items in the keystore.
   ```
   keytool -list -keystore keystore.jceks -storetype jceks -v
   ```
   b) Locate the key alias in the list of items.
3. Using the key alias, export the certificate to a .cer file.
   ```
   keytool -export -alias <key alias> -keystore keystore.jceks -storetype jceks -rfc -file <file name>.cer
   ```
4. Change to your ODBC truststore directory: ODBC\ip\Java\jre\lib\security\cacerts.
5. Import the certificate to your ODBC truststore.
   ```
   keytool -keystore cacerts -importcert -alias $<key alias> -file <file name>.cer
   ```

**Set the ODBC driver properties**

Set the ODBC driver properties to route requests through the Edge Encryption proxy server.

1. In Windows, navigate to Start > Programs > ServiceNow ODBC Management Console.
2. Expand the console tree root to: ServiceNow ODBC Manager\Manager\<installation location>\Services\ServiceNow_ODBC\Data Source Settings\ServiceNow\IP Parameters.
3. Double-click the **DataSourceIPPProperties** attribute.
4. Change the **Value** to the URL of your Edge Encryption proxy server, such as `https://<IP address>:<port>`
5. Click OK.

The ODBC driver is now configured to route requests to the instance through the Edge Encryption proxy server.

**Edge Encryption MID Server integration**

Configure the MID Server to route data through an Edge Encryption proxy server.

When integrated with the MID Server, the Edge Encryption proxy server acts as the MID Server's endpoint. The Edge Encryption proxy server then encrypts and decrypts data passing between the ServiceNow instance and the MID Server.

**Limitations when integrating with the MID Server**

When MID Server data is configured to pass through the Edge Encryption proxy server, the following limitations apply:

- Encryption of ECC Queue fields is not supported.
- Encrypted data cannot be used with Discovery or Service Mapping.

**Point the MID Server to the Edge Encryption proxy server**

To pass data from the MID Server through the Edge Encryption proxy server, update the MID Server configuration file to point the MID Server to the Edge Encryption proxy server.

When configuring the MID Server to pass through the Edge Encryption proxy server, you cannot use the web proxy properties in the MID Server configuration file to route traffic through the Edge Encryption proxy server to your instance. Instead, you must set the Edge Encryption proxy server as the MID Server's endpoint.

1. Navigate to your local MID Server directory and open the `config.xml` file.
2. Find the element `<parameter name="url" value="https://YOUR_INSTANCE.service-now.com" />` and change the value property to the URL of your Edge Encryption proxy server. For example, `http://hostname.mycompany.com:8081`.
   This step directs the MID Server to pass traffic to the Edge Encryption proxy server instead of the instance. The Edge Encryption proxy server then encrypts any necessary fields and passes the payload to the instance.
3. Save and close the file.
4. If running, restart the MID Server.

**Edge Encryption diagnostics and performance**

Monitor Edge Encryption proxy server performance trends and drill into errors generated by the Edge Encryption proxy server.

**Edge proxy performance**

View key Edge Encryption proxy server performance trends using the Edge Proxy graph set on the ServiceNow Performance homepage. Monitored trends include:

- Maximum and average response times between the client, proxy server, and instance.
- CPU, disk space, and memory usage of the host machine.
• Maximum and average network latency between the proxy server and the ServiceNow instance.

**Note:** Edge Encryption proxy servers with duplicate names do not report performance trends.
Maximum and average time in milliseconds to process a request. These data points are general trends over time.

- **Total Time**: Time for the proxy server to receive a request from a client and send a response. This data point is the sum of the subsequent data points.
- **Proxy Response**: Time for the proxy server to process a response from the instance.
- **Proxy-Instance Round Trip**: Time for the proxy server to send a request to the instance and receive a response. Includes network latency between the proxy server and the instance and time spent by the instance to process the request.
- **Rules**: Time for the proxy server to evaluate a request using defined encryption rules.
- **Proxy Request**: Time for the proxy server to process a client request and forward it to the instance.

**Edge Proxy Performance (Max and Average)**

Maximum and average percentage of resources used on the host machine.

- CPU Usage
- Memory Usage
- Disk Usage

**Edge Proxy Latency**

Maximum and average network latency in milliseconds at a given point in time. Latency is determined by round-trip time for a proxy server to send a simple ping to the instance and receive a response.

**Proxy Error Reports**

Navigate to [Edge Encryption Configuration > Diagnostics and Troubleshooting > Proxy Error Reports](#) to view all proxy server errors collected over the past seven days.
Errors are collected over a one-minute period. Each minute, an error report is generated. The vertical axis displays the number of error reports over the last seven days that include each error. For example, even if the DEFAULT_ERROR_CODE error is thrown multiple times over a one-minute report period, the DEFAULT_ERROR_CODE bar will only reach one on the Number of Error Reports axis.

From this view, you can:

- Click each proxy error code bar to see the report on a single error for each proxy server. From this view, you can click the bar again to view the error text in the Edge Encryption Proxy Stat table [edge_encryption_stat]. Follow links in the error text to see more information and possible remediation steps.
- Click Other to see page two of the error report.

**Note:** If you have more than one proxy server with the same name, a single DUPLICATE_PROXY_NAME error appears in the Proxy Error Report. No other errors are reported for proxy servers with duplicate names. If you encounter this error, make sure that all proxy servers have unique names.

### Additional monitoring resources

The instance tracks all encryption proxies. Each Edge Encryption proxy server registers when it starts up. The instance is notified when:

- A new Edge Encryption proxy server starts up.
- An Edge Encryption proxy server is intentionally shut down.

If an Edge Encryption proxy server attempts to register with an instance that does not have Edge Encryption installed, the proxy does not start.
All encryption configuration files are audited. Deleted records are audited on all encryption configuration files. Audit records are put in the sys_audit table. To view the history of a specific configuration record, view the record, and click **History > List** in the menu. The Mass Encryption Job is not audited.

Use the following additional resources to monitor you proxy servers.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid Insert Attempts</td>
<td>List of attempts to save the following data to encrypted fields:</td>
</tr>
<tr>
<td>[sys_edge_encryption_invalid_insert_log]</td>
<td>• Unencrypted data.</td>
</tr>
<tr>
<td></td>
<td>• Data that did not come from an Edge Encryption proxy.</td>
</tr>
<tr>
<td></td>
<td>The instance rejects and then logs any attempts to save this data. If you have the security-admin role, you can view the logs in the Invalid Insert Attempts list.</td>
</tr>
<tr>
<td>Job Failures</td>
<td>A list of jobs that did not execute successfully.</td>
</tr>
<tr>
<td>[sys_encryption_job_execution]</td>
<td></td>
</tr>
<tr>
<td>System logs</td>
<td>The instance periodically checks for messages from each registered proxy server. If a proxy server has not sent a message in the required time frame, an error is logged. The log message contains information about the encryption proxy and the last time the proxy pinged the instance. If the instance determines that none of the encryption proxies are online, it logs a message. These messages are added to the system log.</td>
</tr>
</tbody>
</table>

**Disable or reduce Edge Proxy statistic collection**

Prevent the Edge Encryption proxy server from sending Edge Proxy Graph Set statistics to the ServiceNow Performance homepage, or reduce the frequency of statistic collection.

Role required: admin or security_admin

By adding properties in the `edgeencryption.properties` configuration file, you can:

- Disable the Edge Proxy graph set.
- Change the interval during which statistics are collected by the Edge Encryption proxy server. By default, statistics are collected every 30 seconds.

1. In your proxy server installation directory, open the `edgeencryption.properties` configuration file located in the `<installation directory>/conf/` folder.
2. Add one of the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edgeencryption.stat.collection.enabled</td>
<td>Enables the collection of statistics used by the Edge Encryption proxy server performance dashboard.</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>Add this property and set the value to false to disable the collection of statistics used by the Edge Encryption proxy server performance dashboard.</td>
</tr>
</tbody>
</table>
3. Restart the proxy server.

### Flow Designer

Flow Designer is a Now Platform® feature that gives you rich capabilities for automating processes in a single design environment. Flow Designer lets process owners use natural language to automate approvals, tasks, notifications, and record operations without coding.

You can expand Flow Designer to integrate with external instances and third-party applications with a separate subscription to IntegrationHub.

Watch this seven-minute video to learn how to create and test a flow in Flow Designer.

For developer training, see Using Flow Designer on the ServiceNow® Developer Site.

### Benefits

Flow Designer provides process owners and developers these benefits.

- Consolidates multiple Now Platform automation capabilities into a single environment so process owners and developers can build and visualize business processes from a single interface. Includes flows and actions triggered by Service Catalog events. See Create a flow with a Service Catalog trigger.
- Consolidates configuration and runtime information into a single environment so process owners and developers can create, operate, and troubleshoot flows from a single interface.
- Provides natural-language-descriptions of flow logic to help non-technical users understand triggers, actions, inputs, and outputs.
- Promotes process automation by enabling subject matter experts to develop and share reusable actions with flow designers.
- Reduces upgrade costs, with upgrade-safe Now Platform® logic replacing complex custom script.
- Reduces development costs by providing a library of reusable actions.
- Allows extending Flow Designer content by subscribing to IntegrationHub or installing spokes.

### Interactions with existing automation processes

While learning Flow Designer, make sure that you understand how existing Now Platform automation processes such as business rules and workflows change records to avoid creating conflicting logic. See the Architecture Overview to understand how Flow Designer works within the Now Platform. Avoid duplicating existing business logic from business rules and workflows. If you are replacing an existing automation process, you may need to deactivate it before replacing it with Flow Designer flows and actions.
Flow Designer content

Flow Designer consists of the following content types.

Flows

A flow is an automated process consisting of a sequence of actions and a trigger. Flows automate business logic for a particular application or process. For example, the VTB Sample Flow creates and assigns a VTB card whenever a priority 1 incident is created. Flows require some familiarity with the Now Platform tables and fields the application or process uses. Process analysts can create flows using available actions or copy an existing flow to use it as a template. You can add application-specific flows by activating the associated spoke.

Subflow

A subflow is an automated process consisting of a sequence of reusable actions and specific data inputs that allow it to be started from a flow, subflow, or script. Subflows automate generic business logic that can be applied to multiple applications or processes. For example, you could create a subflow to notify users of record changes. Subflows require some familiarity with the Now Platform tables and fields the application or process uses. Process analysts can create subflows using available actions or use an existing flow as a template.

Actions

An action is a reusable operation that enables process analysts to automate Now Platform features without having to write code. For example, the Create Record action allows process analysts to generate records in a particular table with particular values when certain conditions occur. Core actions like Create Record require some familiarity with Now Platform tables and fields. Action designers can create application-specific actions to pre-set configuration details. For example, creating a Create Incident Task action ensures that the process analyst uses the correct table and field configuration each time the action is used. You can add application-specific actions by activating the associated spoke.

Core actions

A core action is a ServiceNow-provided action available to any flow that cannot be viewed or edited from the Action Designer design environment. For example, the Ask for Approval action is a core action that allows process analysts to use Now Platform approvals. Flow Designer provides a set of core actions to automate Now Platform processes. You can add application-specific core actions by activating the associated spoke.

Action steps

An action step or step is a single reusable operation within an action. For example, the Create Record step allows action designers to specify the table and field values to use during record creation. Action steps require subject matter expertise with application tables, fields, and business logic. Application developers or IT generalists add action steps to actions from the Action Designer design environment. Flow Designer provides a set of core action steps to automate Now Platform processes. You can add application-specific action steps by activating the associated spoke.

Spokes

A spoke is a scoped application containing Flow Designer content dedicated to a particular application or record type. For example, the ITSM Spoke contains actions for managing Task records such as the Create Task action. Spokes are activated when their parent application is activated. For example, the ITSM Spoke is activated when the Incident, Problem, and Change applications are activated. Creating a spoke requires familiarity with application development as developers must add Flow Designer content to a scoped application. See Spokes for a list of available spokes.
Consolidated design and operation environment

The design environment consists of these components.

**Landing page**
Access or create actions, flows, subflows, or their execution details.

**Flow Designer**
Create and edit flows by defining a trigger and adding actions. Test flows to see if they complete successfully and to review the runtime values they generate. Activate flows to make them available for execution on your instance and to preserve their current actions, inputs, and sequence as a snapshot separate from further configuration changes.

**Action Designer**
Create and edit actions by defining inputs and adding action steps. Test actions to verify if they complete successfully and review the runtime values they generate. Copy actions to use existing actions as templates. Publish actions to activate them, which makes them available to activated flows and to preserve their current action steps, variables, and sequence as a snapshot separate from further configuration changes.

**Flow and action execution details**
View runtime information about an action or flow directly from the design environment such as the current state, actions or steps run, and values produced. Open related records from embedded Now Platform editors or in a new tab.

**Operations dashboard**
Identify and troubleshoot potential issues by reviewing action and flow executions, their result state, and their run time duration.

Getting started with flows

Create a sample flow with a trigger and base system actions that requires an approval.

Role required: admin

**Note:** While Flow Designer is designed to use the flow_designer and delegated_developer roles in most scenarios, this tutorial uses the admin role to illustrate functionality without requiring additional roles to set up records and approve requests.

The ITSM application is required to access the Task table.

Watch this 11-minute video for an introduction to using Flow Designer.

A flow can include these components:

- **Trigger:** An activity that initiates the flow, such as a record created in a specified table or a scheduled job.
- **Conditions:** Statements that determine when or how an action runs. For example, run an action only if a field is over a certain value.
- **Actions:** Operations executed by the system, such as a field value updated, approval requested, or a value logged.

To understand basic flows, create an expense approval flow. This flow:

1. Runs when an Expenses record is created.
2. Uses the total amount to determine which action to run.
3. Approves the request if it is under the specified dollar amount.

4. Requires manager approval if it is over a specified dollar amount. Another approver can be manually added.

1. Create a custom application for the flow. Creating flows and actions within an application enables you to publish flows and actions to an application repository and deploy them on other instances. While this example does not use delegated development, you can optionally delegate action and flow designer development by assigning developers to the application.
   a) Navigate to **System Applications > Studio**.
   b) Create a custom application called **Expenses Getting Started**.

2. In Studio, create an Expenses table.
   a) Click **Create Application File**.
   b) Under Data Model, select Table and click **Create**.
      A Table form opens.
   c) Complete the form with the following values.
      - Label: **Expenses**
      - Extends table: **Task**
   d) Save the form.
   e) Add three additional columns to the table.

<table>
<thead>
<tr>
<th>Column label</th>
<th>Type</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>Floating point number</td>
<td>None</td>
</tr>
<tr>
<td>Destination</td>
<td>String</td>
<td>None</td>
</tr>
<tr>
<td>Requested for</td>
<td>Reference</td>
<td>User [sys_user]</td>
</tr>
</tbody>
</table>

3. Add four records to the Expenses table to use in Flow Designer tests. When you test your flow in later steps, you can specify which record is used as the trigger, enabling you to test specific record values.
   a) On the Expenses table record, click the **Show list** related link.
   b) Click **New**.
   c) Configure the form to add the **Amount**, **Destination**, and **Requested for** fields, and the **Approvers** related list.
   d) Complete the **Destination** and **Requested for** fields. In the **Amount** field, add a value under 100.00.
      Make sure that the user in the **Requested for** field in the test record has a manager assigned in the system. If the user in the test record does not have a manager, configure the User form to add the **Manager** field, and assign a manager to the user.
   e) Submit the form.
   f) Add another record to the table with an amount under 100.00.
   g) Add two more records to the table with a value over 100.00 in the **Amount** field.
4. In Studio, create a new flow.
   a) Click Create Application File.
   b) Under Flow Designer, select Flow and click Create.
   c) Select the Flow option, click Next.
   d) In the Flow Name field, enter Expense Approval.
   e) Click Submit.
      An Expense Approval flow is created in the Expenses Getting Started scope.

5. Create a trigger that runs the flow when a record is created in the Expenses table.
   • Trigger: Created
   • Table: Expenses [x_expenses_getting_expenses]

   ![Trigger Configuration](image)

   6. Add an if condition to the flow.
      a) Select Flow Logic > If.
      b) In the right-hand pane, expand the Trigger - Record Created category and the [Expenses Record] pill. Drag-and-drop the [Amount] pill into Condition 1. A data pill represents the value
of a record or a field at a particular stage in your flow. Dragging the \[\text{Amount}\] data pill from the trigger populates the condition with the value of the field in the triggering record.

c) Set Condition 1 to \([\text{Trigger}\rightarrow\text{Expenses Record}\rightarrow\text{Amount}] \text{ less than } [100.00]\).

7. Underneath action 1, click + to add an action that runs when the If condition is met.
8. Create an Update Record action that approves the request.
   - Action: **Update Record**
   - Record: Expand the **Trigger - Record Created** category and drag the **[Expenses Record]** data pill from the right-hand pane.
   - Table: Set to **Expenses [x_expenses_getting_expenses]**.
   - Fields:
     - Approval: **Approved**
     - Work notes: **Auto-approved. Amount less than $100.00**

9. Add an else condition to the flow.
   a) Select **Flow Logic > Else**.
10. Underneath action 2, click + to add an Ask for Approval action that runs when the Else condition is met.
   
a) Complete the fields in the Ask for Approval step.
   
   • **Action:** Ask for Approval
   • **Record:** Expand the [Trigger - Record Created] category and drag the [Expenses Record] data pill from the right-hand pane.
   • **Table:** Set to Expenses [x_expenses_getting_expenses].
   • **Approval Field:** Set to Approval.
   • **Journal Field:** Set to Approval history.

   ![Ask for Approval screenshot]

b) Define the rules in the Ask for Approval step.

   • [Approve] when [Anyone approves] from the field [Trigger->Expenses Record->Requested for->Manager]. [OR]
   
   • **[Anyone approves]** from the [Manual User(s)] list. Select to allow a manual approver to process an approval or rejection. A manual approver is a user manually added to the Approvers related list who can then approve the request. For example, you can manually add
a subject matter expert to a task to approve the request. To learn more about adding manual approvers, see Generate approvals using the approvers related list.

Select **Add another OR rule set** to define rejection rules. When defining approvals, make sure to include rejection rules to avoid creating flows that remain in a waiting state if there are no matching approval rules.

- **[Reject]** when **[Anyone rejects]** from the field **[Trigger->Expenses Record->Requested for->Manager]**. [OR]
- **[Anyone rejects]** from the **[Manual User(s)]** list.

![Rules](image)

**c)** Define a due date to automatically approve, cancel, or reject an approval if the request is not approved or denied by the designated time. Adding a due date ensures that the flow does not remain in a waiting state.

- **[Approve]** if pending by **[Relative date] [1][Days] from [Trigger->Expenses Record->Created]**.
- Days schedule **[8-5 weekdays excluding holidays]**.

This due date automatically approves all requests that have not been approved or denied within one day from when the request was created.

![Due Date](image)

11. **Click Save.**
12. Test the flow using a record with an amount below the designated limit.
   a) From the flow, click Test.
      The Test flow modal appears.
   b) In the Record field, select a record you created in earlier steps that has value in the Amount field under the 100.00 limit. This field is a reference to the table defined in the trigger.

      **Note:** Testing a flow bypasses the trigger conditions and immediately runs it. To test a flow with a record-based trigger, you must select a specific record to act as the trigger.
   c) Select Run Test.
   d) After the flow executes, click Flow has been executed. To view the flow, click here.
      The Execution Details open.

Because the amount is less than 100.00, the first condition is met and the request is approved.

13. Navigate back to the flow and run the test again using a record with an amount over the designated amount.
14. After the flow executes, open the flow Execution Details. Because the amount is over the designated limit, the request must be approved. Until a manager or a manual approver approves the request, the state is **Waiting**.
15. Approve the request. In an active flow, a user from the Approvers list would approve or reject the request. However, because the flow is being tested, an admin can approve the flow.
   a) Navigate to the test record.
      The associated manager appears in the Approvers related list with Requested in the State field. Alternatively, you can edit the list to add manual approvers.
   b) Change the value of the State field in the Approvers related list to Approved.
   c) Navigate back to the flow Execution Details and refresh the browser. Because the request is approved, the flow completes.

   Transform the Ask for Approval action into a reusable action using Action Designer. Actions enable flow designers to add complex actions to multiple flows with minimal configuration. See Getting started with actions.

   Getting started with actions
   Transform the Ask for Approval action into a reusable action that always requires manager approval.
   Role required: admin
Complete the steps in Getting started with flows. This tutorial replaces the Ask for Approval action in the Expense Approval flow.

Actions are made up of:

- **Inputs:** Data variables used in your action.
- **Steps:** Operations on the inputs or results from a prior step that generate data that can be used in later steps.
- **Outputs:** Data variables that represent the results of the action. These results are available to other actions in a flow.

Unlike the core Ask for Approval action where flow designers must manually configure the approval rules, this custom action always uses the same approval rules when added to a flow. You might create a reusable action if your flow designers often use an action with the same configuration. For example, if your flow designers always use the request manager approval and due date options, this action automatically uses them and therefore requires less flow configuration.

1. Open the Expenses Getting Started application in Studio.
   Alternatively, you can navigate to **Flow Designer > Designer** and select **New Action** to access Action Designer in the platform. In the Action Properties, select your scoped application in the **Application** field.

2. Create an action.
   a) Click **Create Application File**.
   b) Under Flow Designer, select Action and click **Create**.
   c) In the **Name** field, enter Ask for Manager Approval.
   d) In the **Description** field, enter Approve or reject a request based on manager approval or rejection. Allow manual approvers to be added.
   e) Click **Submit**.

   An Ask for Manager Approval action is created in the Expenses Getting Started scope.
3. Define the inputs in the Ask for Manager Approval action.
   a) Select **Create Input** and add the following values.
      - Name: **Request**
      - Type: **Reference**
      - Reference Table: **Expenses [x_expenses_getting_expenses]**

This input enables you to reference any field or record from the Expenses table. Use the data pills on the right-hand side to add the record or its fields to action steps.
4. Add an Ask for Approval step.
   a) Click the + underneath Inputs in the Action Outline.
   b) Select Ask for Approval.
   c) Complete the fields in the Ask for Approval step.
      • Record: Under the Input Variables category, drag the [Request] data pill from the right-hand pane.
      • Table: Set to Expenses [x_expenses_getting_expenses].
      • Approval Field: Set to Approval.
      • Journal Field: Set to Approval history.

d) Define rules in the Ask for Approval step. You can use the data pill picker, or drag the data pills from the right-hand pane to select the data you need.
   • [Approve] when [Anyone approves] from the field [action->Request->Requested for- >Manager]. [OR]
   • [Anyone approves] from the field [Manual User(s)].

Select Add another OR rule set to define rejection rules:
   • [Reject] when [Anyone rejects] from the field [action->Request->Requested for- >Manager]. [OR]
   • [Anyone rejects] from the field [Manual User(s)].
e) Define a due date in the Ask for Approval step.
   - [Approve] if pending by [Relative date] [1][Days] from [action->Request->Created].
   - Days schedule [8-5 weekdays excluding holidays].

This due date automatically approves all requests that have not been approved or denied within one day from when the request was created.
5. Define the outputs in the Ask for Manager Approval action. Adding an output makes data available to a flow. For example, this action outputs the approval state of the record.
   a) Select **Create Outputs** and add the following values.
      • Name: **Approval state**
      • Value: In the right-hand pane, expand the **Ask for Approval step** category and drag the **[Approval State]** data pill.

![Action Outline Diagram]

   b) Click **Save**.

6. Add a custom icon for your application that displays in Flow Designer. All actions in the application scope use the custom icon.
   a) In Studio, navigate to **File > Settings**.
      The application settings open.
   b) In the **Logo** field, select **Click to add**.
   c) Upload an icon to use with your reusable actions.
7. Test the reusable action within your flow.
   a) Return to the Expense Approval flow.
   b) Remove the 2.1 Ask for Approval action from the flow. This action will be replaced by the reusable Ask for Manager Approval action.
   c) Set Show draft actions to true.
   d) Add the Ask for Manager Approval action to your flow.
   e) In the right-hand pane, expand the Trigger - Record Created category and drag the [Expenses Record] data pill into the Request [Expenses] field.
8. Click **Save**.
9. Test the flow using a record with an amount below the designated limit.
   
a) From the flow, click **Test**.
   
The Test flow modal appears.

b) In the **Record** field, select a record you created in earlier steps that has value in the **Amount** field under the 100.00 limit. Verify that you have not already run tests using this record.

c) Select **Run Test**.

d) After the flow executes, click **Flow has been executed. To view the flow, click here**.
   The Execution Details open.

Because the amount is less than 100.00, the first condition is met and the request is approved. The Else condition is not evaluated.
10. Test a record with an amount over the designated limit. Verify that you have not already run a test on the test record. Because the amount is over the designated limit, the second condition is evaluated.
11. Approve the request.
   a) Navigate to the test record and change the value of the State field in the Approvers related list to Approved.
   b) Navigate back to the flow execution details and refresh the browser. Because the request is approved, the flow completes.

12. Navigate to the Ask for Manager Approval action and click Publish. Publishing an action enables you to activate any flow that uses it.
13. Navigate to the flow and set Show draft actions to false.
14. Click Activate. Activating a flow sets it to run every time the trigger conditions are met.

The Expense Approval flow runs every time a record is created in the Expenses table. Now that the flow is activated and working as expected, you can publish it to the application repository and deploy it to other instances.

Architecture Overview

Understand how Flow Designer works within the Now Platform to activate, trigger, and process flows and actions.
A flow consists of a *trigger* and one or more actions. The trigger specifies when to start the flow, which can be *record-based*, *schedule-based*, or *application-based*. Record-based triggers run a flow after a record has been created, updated, or deleted. The flow can use the triggering record as input for actions. Schedule-based triggers run a flow at the specified date and time. The flow can use the execution time as input for actions. Application triggers are added when the associated application is activated. For example, the MetricBase trigger is present when the MetricBase application is active.

**Flow processing**

Flow processing occurs in this sequence.

1. When the flow trigger conditions occur or an API directly calls the flow, the system creates an entry in the event queue to start the flow.
2. The scheduler processes the event and starts the flow in the background.
3. The system builds a process plan from the flow.
4. The system runs the process plan using the record that triggered the flow.
5. The system stores the execution details in a context record.

1. **Process flow triggers and API calls**

   Each time trigger conditions are met or an API directly calls a flow, Flow Designer creates an event entry. The system processes triggers after database operations. To learn more, see #unique_817. Typically, *business rules* and *workflows* that run synchronously run before a triggered flow.

2. **Process events in the queue**

   Each flow event contains a reference to the flow to start and a reference to either the triggering record or the execution time. The system processes these events using *Standard event processing* where a scheduler periodically works through the current items in the event queue in the order in which they were added. Depending on what other events are in the queue, the system may not immediately start a flow. Flow designers should expect some lag time between when the trigger conditions occur and when the flow actually starts.
3. Build the process plan

When Flow Designer pulls an event from the queue, it builds a process plan to actually run the flow. A process plan contains all the information necessary to execute a flow such as the sequence of published actions or subflows, the input values for each subflow or action, the action steps to run for each action, and the data provided by the trigger or subflow output.

Flow Designer uses a just-in-time compilation scheme to ensure that process plans contain the latest changes to flows, subflows, and actions. If no changes are detected, Flow Designer uses a cached copy of the process plan. Otherwise, it builds a new process plan.

By automatically checking for updated flows, subflows, and actions with process plans, Flow Designer enables you to apply changes from update sets and upgrades without having to edit current flows. If you move published actions to a target instance, every flow that uses the published action will automatically update the next time it is executed.

**Warning:** If changing subflows or actions used in activated flows, do not change the inputs and outputs used in the subflow or action. Changing inputs and outputs may cause errors when the activated flow is next triggered because it has not been configured to use the new inputs and outputs. Any currently running flows are unaffected by changes to inputs or outputs as the flow uses the compiled subflows and actions from the process plan.

4. Run the process plan

Flow Designer runs the process plan as the System user within the flow application scope.

When running a flow with a record-based trigger, Flow Designer stores the triggering record in memory as an instance that is represented in the interface as a data pill.

The instance contains the record values from when the flow started, which may be different than the current record stored in the database. For example, suppose that creating an incident record triggers a flow. Any changes a user makes to the incident record after the flow has started do not update the triggering record unless an action specifically looks up the current record value.

5. Store flow execution details

Flow Designer stores flow execution details in a flow context record, which contains this information.

- Flow outcome state
- Flow runtime duration
- Flow log messages
- Flow configuration and runtime values

Each time a flow runs, Flow Designer adds an entry to the Flow Executions list. Each entry has its own context record and matching execution details page.

A flow can have one of these outcome states.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete</td>
<td>The flow completed successfully.</td>
</tr>
<tr>
<td>In Progress</td>
<td>The flow is running. By default, a transaction quota rule prevents flows from running longer than an hour.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The flow is waiting for another event to occur. For example, a user must update a task or approval, or a record must reach a specific state. When in the waiting state, the flow is quiesced and serialized into a context record.</td>
</tr>
<tr>
<td>Canceled</td>
<td>The flow was canceled by a user.</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Error</td>
<td>The flow encountered an error and has stopped running. For example, an action is missing an input value, or a quota transaction rule has stopped the flow.</td>
</tr>
</tbody>
</table>

### Flow, subflow, and action life cycle

Flow Designer uses the flow or action status to describe the current state of configuration changes.

#### Flow and subflow status and activation state

The **Status** field indicates whether there is a process plan associated with the flow or subflow.

<table>
<thead>
<tr>
<th>Flow status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modified</td>
<td>Indicates that there are unsaved changes to a flow or subflow. Modified flows or subflows have not been saved.</td>
</tr>
<tr>
<td>Draft</td>
<td>Indicates that there are saved changes to a flow or subflow, which have not been stored in a process plan. Draft flows have been saved but not activated. Draft subflows have been saved but not published.</td>
</tr>
<tr>
<td>Published</td>
<td>Indicates that there is a stored process plan for the flow or subflow. Published flows have either been activated or deactivated.</td>
</tr>
</tbody>
</table>

The **Active** field indicates whether the system runs a flow or subflow.

<table>
<thead>
<tr>
<th>Active</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>True</td>
<td>Indicates that the flow or subflow is active and runs when triggered or called. The flow has been activated or the subflow has been published. Active flows run when the trigger conditions are met or when called. Active subflows run when called.</td>
</tr>
<tr>
<td>False</td>
<td>Indicates that the flow is inactive and does not run when triggered or called. An inactive flow has either never been activated or has been deactivated. An inactive subflow has never been published.</td>
</tr>
</tbody>
</table>

When working with flows, you can:

- **Save** a flow: Creates a draft of the flow.
- **Activate** a flow: Enables the flow trigger and transform the flow into a process plan.
- **Deactivate** a flow: Disables the flow trigger and prevents new flow executions. Currently running flows continue to run.

When working with subflows, you can:

- **Save** a subflow: Creates a draft of the subflow. If the subflow is modified after being published, the subflow moves into a draft state. Any active flows that use the subflow only run the published subflow.
- **Publish** a subflow: Enables you to activate a flow containing the subflow. Publishing adds the subflow to the list of available subflows in a flow.
**Action status**

The Action Designer interface does not display the configuration status of actions. To view action status, navigate to the Action Types table [sys_hub_action_type_definition] and display the Draft state field.

<table>
<thead>
<tr>
<th>Action Draft status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>Indicates that there are changes to an action that have not been published. Draft actions are only available to flows when the Show draft actions option is enabled. You cannot activate a flow containing draft actions.</td>
</tr>
<tr>
<td>Published</td>
<td>Indicates that the action has been published. Published actions are available to all flows and allow flows to be activated.</td>
</tr>
</tbody>
</table>

When working with actions, you can:

- **Save an action**: Creates a draft of the action that is only available to flows when Show draft actions is enabled. If the action is modified after being published, the action moves into a draft state. Any active flows that use the action only run the published action.
- **Publish an action**: Enables you to activate a flow containing the action. Publishing adds the action to the list of available actions in a flow. Only actions in a published state run during flow execution.

**Application development**

When designing an action or a flow, use these design considerations as a guide.

Use standard Now Platform application development capabilities to create, manage, protect, and deploy Flow Designer content. Flow and action designers typically perform these application development tasks.

- Create a custom application to store flows and actions.
- Set application permissions to share or restrict access to application data.
- Grant application developers access to Flow Designer.
- Publish custom applications to the application repository to deploy flows and actions on other instances.
Security

Control access to Flow Designer processes and records.

- Administrators can grant users access to Flow Designer by creating an application and assigning users as developers with the Flow Designer delegated development permission. Delegated development allows administrators to control whether flow designers can access features normally restricted to admin users such as assigning user roles, creating access controls, or creating scripts. See Developer permissions.

- Administrators can also grant access to Flow Designer by directly assigning users the flow_designer user role, which includes the role to view flow execution details.

  **Warning:** Directly granting a user the flow_designer role is equivalent to giving the user the admin role, because Flow Designer can run flows as the System user, which has access to all tables and all database operations.

- Flow and action designers can use standard #unique_822 to manage how their content interacts with other applications.

Action limit

By default, flows can have no more than 50 actions. To change the default behavior, increase the value of the sn_flow_designer.max_actions system property. However, consider the performance impact that a large flow may have on your instance.

Trigger options for record updates

Flow designers can specify how often a flow can update a particular record with the Run Trigger option. Use the Once option when you want a flow to run only once. The first time a record is updated, the flow runs, but any further record updates do not trigger the flow. Use the Always option when you want the flow to run every time a record is updated and there is not already an active flow running for it. For example, you might set a flow that assigns an incident record to run only once, and set a flow that notifies the incident watch list to always run. The Run Trigger field is only available for these trigger types.

- Created or Updated
- Updated

Direct recursion prevention and indirect recursion limit

To prevent instance outages and consumption of system resources, Flow Designer ignores any request to start a flow or subflow that is the result of direct recursion. Direct recursion occurs under these conditions.

- An action calls the same flow that it is part of. For example, a script step makes an API call to a flow.
- An action or subflow produces a result matching the flow trigger. For example, a flow that runs when an incident record is updated contains an update record action that updates an incident record.

Flow Designer also limits the number of times a flow can be started from indirect recursion. Indirect recursion occurs under these conditions.

- The same flow is called multiple times in a chain of subflow calls. For example, if subflow A calls subflow B, and subflow B calls subflow A, then calling either subflow produces indirect recursion.
• The same flow is triggered multiple times in a chain of subflows. For example, suppose that there are two flows triggered by record creation. Suppose that creating record A triggers flow A and also creates record B. Furthermore, creating record B triggers flow B and creates record A. Creating either record type produces indirect recursion.

By default, the system stops triggering flow runs after the run count reaches the indirect recursion limit of three runs. Administrators can change the limit by setting the system property com.glide.hub.flow_engine.indirect_recursion_limit to an integer value equal to or greater than one. The system ignores any property value less than one and instead uses a limit of one. Consider the performance impact that increasing the indirect recursion limit may have on your instance.

Note: By default, a transaction quota rule prevents flows from running longer than an hour.

Flow and action testing

Testing a flow bypasses the trigger conditions and immediately runs it. Testing a flow with a record-based trigger requires selecting a specific record to act as the trigger. Flow designers should generate appropriate sample records prior to testing.

During the design phase, you can test an inactive flow and unpublished actions by setting Show draft actions on the flow. If testing with draft actions, use these guidelines.

• Design flows and actions on a non-production instance. Only deploy active, working flows to your production instance.
• Leave Show draft actions set to true until your draft is in a final state. Once final, publish each action, set Show draft actions to false, and activate the flow.

Warning: Disabling Show draft actions before publishing your actions removes all draft actions from your flow.

• Any change you make to an active flow or published action causes it to return to a draft state. If the flow is triggered, the system only runs the activated flow and published actions, and the flow execution details only display what was run. When there is a draft of an active flow, the trigger and actions listed in the flow execution details may be different than those listed in the draft flow.

Flow Designer data

Each time you add an action to a flow, Flow Designer adds a data pill to store its results. The data pill name indicates its sequence in the flow and its data type.

Flow designers use action result data pills to provide input for other flows, actions, or subflows. Flow designers can use the sequence value in the data pill name to ensure that they select the correct data pill as an input value. When a flow runs an action, it generates the data pill runtime value, which remains the same for the duration of the flow. For example, if a data pill for [Trigger->Incident record] gets populated with incident record values at the start of a flow, the data pill preserves these values for the rest of the flow.

Data pill population

Flow Designer populates data pill values as soon as the data becomes available regardless of where the data pill is located in the flow sequence. For example, suppose that you have a flow triggered by the creation of an incident record with the following actions:

1. Update [Incident] Record that adds a text string to [Trigger->Incident Record->Short description].
2. Log the value of [Trigger->Incident Record->Short description].
3. Log the value of [1->Incident Record->Short description].

Action-1 and Action-2 both use the data pill [Trigger->Incident Record->Short description]. Since the trigger record is available as soon as the flow starts, these values are set before running these actions.

**Delayed data pill population**

When an action, flow logic, or step includes more than one data pill in the same input, the system delays running it until all data pill values have been populated. This delay might produce unexpected values or prevent flow logic from running at all.

For example, this flow produces unexpected values.

1. Update [Incident] Record that adds a text string to [Trigger->Incident Record->Short description].
2. Log the value of [Trigger->Incident Record->Short description].
3. Log the value of [1->Incident Record->Short description].
4. Log the value of [Trigger->Incident Record->Short description] and [1->Incident Record->Short description].

This flow produces the unexpected result of both data pills in Action-4 evaluating to the same value.

**Flow administration modules**

Identify and troubleshoot potential issues by reviewing action and flow executions, their result state, and their run time duration.

Flow Designer provides administrators and flow operators these modules to manage flows.

- **Today's Executions**
  Displays a list of flow context records for flows run today. Use this information to identify flows run today.

- **Active flows**
  Displays a list of flow context records for running flows where the State is Waiting. Use this information to identify flows that are waiting for a trigger or condition to continue.

- **Event Queue**
  Displays a filtered list of event records where the Queue is flow_engine and the State is Ready. Use this information to identify flows that are waiting on event processing.

- **Operations Dashboard**
  Displays a responsive dashboard containing a count of flows run and the average flow runtime. View statistics for today or over the last 30 days. Use this information to determine the health and performance of flow execution.

- **Settings**
  Displays the list of Flow and Action Settings records. Use this table to identify which actions and flows have had reporting disabled. Create records on this table to control whether reporting is done on an action or flow.

- **Properties**
  Displays the system properties used to configure how the system processes flows.
Displays transaction counts between your instance and third-party systems. The Usage Overview is not available in the base system and requires the ServiceNow® IntegrationHub subscription.

Flow Designer landing page
Access or create actions, flows, subflows, or their execution details.

Flows
The Flows screen contains all the flows that your installation of Flow Designer can use. Selecting a flow opens the flow in a new tab. You can see the scope the flow was created in, the internal name of the flow, whether the flow is published or in draft status, whether the flow is active, and update information.

Subflows
The Subflows screen contains all the subflows that your installation of Flow Designer can use. Selecting a subflow opens the subflow in a new tab. You can see the scope the subflow was created in, the internal name of the subflow, whether the subflow is published or in draft status, whether the subflow is active, and update information.

Actions
The Actions screen contains all the actions that your installation of Flow Designer can use. Selecting an action opens the action in a new tab. You can see the scope the action was created in, where the action is accessible from, whether the action is active, and update information.

Executions
The Executions screen shows a history of actions and flows run, including the current state and duration of each run.

Help
The Help landing page contains links to Flow Designer Guided Tour, Documentation, Videos, and Community Discussion.

+ New
You can create a new flow or action by selecting an action from the list.
Flow Designer system properties

Configure how the system processes flows.

These properties are available for Flow Designer.

To set Flow Designer system properties, click Flow Designer > Properties or navigate to the System Properties [sys_properties] table.

### Properties for Flow Designer

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The maximum number of records to return when</td>
<td>Specify the maximum number of records a look up action or step can return. Flow Designer ignores records that exceed this limit.</td>
</tr>
<tr>
<td>fetching data</td>
<td>• Type: integer</td>
</tr>
<tr>
<td>sn_flow_designer.action_picker_limit</td>
<td>• Default value: 1000</td>
</tr>
<tr>
<td></td>
<td>• Location: Flow Designer &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>• Learn more: Architecture Overview</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set to True to show duration in the stage column</td>
<td>Specify whether flows with stages display a duration.</td>
</tr>
<tr>
<td>com.glide.hub.flow_engine.stage_display.show_duration</td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: Flow Designer &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>• Learn more: Flow Designer stages</td>
</tr>
<tr>
<td>Allow the option for select users to write a script to populate the value</td>
<td>Specify whether users can write inline scripts to compute input values.</td>
</tr>
<tr>
<td>of an input on Flow and Action Designers.</td>
<td>• Type: true</td>
</tr>
<tr>
<td>sn_flow_designer.input_scripts_enabled</td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: Flow Designer &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>• Learn more: Inline scripts</td>
</tr>
<tr>
<td>Specify the log level of system log entries to replicate to the flow</td>
<td>Specify the threshold required for Flow Designer to replicate a system log entry to the flow log. Flow Designer only replicates system log entry at the given level or higher. Options include:</td>
</tr>
<tr>
<td>log entries. The system only replicates log entries of the specified</td>
<td>• DEBUG</td>
</tr>
<tr>
<td>level or higher.</td>
<td>• INFO</td>
</tr>
<tr>
<td>com.glide.hub.flow_engine.listener_trace.threshold</td>
<td>• WARN</td>
</tr>
<tr>
<td></td>
<td>• ERROR</td>
</tr>
<tr>
<td></td>
<td>• Type: choice</td>
</tr>
<tr>
<td></td>
<td>• Default value: ERROR</td>
</tr>
<tr>
<td></td>
<td>• Location: Flow Designer &gt; Properties</td>
</tr>
<tr>
<td>Maximum iterations per loop.</td>
<td>The maximum amount of iterations that a loop will run in flow designer. A loop will error out if it iterates beyond this value, preventing infinite loops.</td>
</tr>
<tr>
<td>sn_flow_designer.max_iterations</td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1000</td>
</tr>
<tr>
<td></td>
<td>• Location: Flow Designer &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>• Learn more: Architecture Overview</td>
</tr>
<tr>
<td>Note: Changing this value will not effect flows that are already in</td>
<td></td>
</tr>
<tr>
<td>progress.</td>
<td></td>
</tr>
<tr>
<td>Enable flow engine debug messages in the system log</td>
<td>Enable or disable logging Flow Designer debug messages in the system log. All debug messages start with a Flow Designer: string prefix.</td>
</tr>
<tr>
<td>com.glide.hub.flow_engine.debug</td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Flow Designer &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>• Learn more: Architecture Overview</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Enable replication of system log entries to the flow log. Only entries replicated to the flow log are visible from the Flow Execution Details page. All log entries are visible from the system log. com.glide.hub.flow_engine.listener_trace | Enable or disable replication of system log entries to the flow log. The Flow Execution Details page can only displays log entries available in the flow log.  
• Type: true | false  
• Default value: false  
• Location: Flow Designer > Properties |
| Number of times that a flow or subflow can be indirectly triggered during a transaction. com.glide.hub.flow_engine.indirect_recursion_limit | Specify the maximum number of times a flow or subflow permits indirect recursion. Flow Designer ignores all further calls or trigger condition matches from indirect recursion after the limit has been reached. Set the value to any integer equal to or greater than one. The system ignores any property value less than one and instead uses a limit of one. Set the value to one to prevent all indirect recursion.  
• Type: integer  
• Default value: 3  
• Location: Flow Designer > Properties  
• Learn more: Architecture Overview |
| Maximum actions per flow. sn_flow_designer.max_actions | Specify the maximum number of actions a flow or subflow can contain. Flow Designer prevents you from adding further actions after the maximum number of actions has been reached. Consider the performance impact raising the maximum number of actions may have. For example, running more actions may conflict with the default transaction quota rule that prevents flows from running longer than an hour.  
• Type: integer  
• Default value: 50  
• Location: Flow Designer > Properties  
• Learn more: Architecture Overview |
| Maximum steps per action. sn_flow_designer.max_action_steps | Specify the maximum number of steps that an action can contain. Flow Designer prevents you from adding further steps after the maximum number of steps has been reached. Consider the performance impact raising the maximum number of steps may have. For example, running more steps may conflict with the default transaction quota rule that prevents flows from running longer than an hour.  
• Type: integer  
• Default value: 20  
• Location: Flow Designer > Properties  
• Learn more: Architecture Overview |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level of reporting data generated by the flow engine</td>
<td>Specify when Flow Designer generates execution details and what information the details include. Options include:</td>
</tr>
</tbody>
</table>
| com.snc.process_flow.reporting.level               | • Off  
|                                                   | • Flows Only  
|                                                   | • Flows and Actions  
|                                                   | • Flows Actions and Steps  
|                                                   | • Developer Trace  |
|                                                   | **Note:** Testing an action or flow generates execution details at the Developer Trace level.  |
|                                                   | - Type: choice  
|                                                   | - Default value: Flows Actions and Steps  
|                                                   | - Location: Flow Designer > Properties  |
| Truncate runtime values in the flow execution details step configuration. | Specify the number of bytes allowed for runtime values in each step in the flow execution details. To prevent truncation, set the value to an integer equal to or less than zero.  |
| com.snc.process_flow.reportingserialized.val_size_limit | - Type: integer  
|                                                   | - Default value: 16384  
|                                                   | - Location: System Properties [sys_properties] table  
|                                                   | - Learn more: Flow execution details  |
| Maximum inputs per action                          | Specify the maximum number of inputs that can be added to an action. Flow Designer prevents you from adding further inputs after the maximum number of inputs has been reached. Consider the performance impact raising the maximum number of action inputs may have. For example, processing more action inputs may risk the action running for more than an hour and being stopped by the default transaction quota rule.  |
| sn_flow_designer.max_action_vars                   | - Type: integer  
|                                                   | - Default value: 20  
<p>|                                                   | - Location: System Properties [sys_properties] table  |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum script variables per Script step sn_flow_designer.max_script_variables | Specify the maximum number of input and output variables that can be added to a Script step. Flow Designer prevents you from adding further script variables after the maximum number of variables has been reached. Consider the performance impact raising the maximum number of script variables may have. For example, processing more script variables may risk the Script step running for more than an hour and being stopped by the default transaction quota rule.  
  • Type: integer  
  • Default value: 20  
  • Location: System Properties [sys_properties] table |

**Flows**

Automate processes with a sequence of reusable actions such as manage records, ask for approvals, create tasks, and send notifications. Define trigger conditions to start a flow and variables to pass information between actions.

All flows consist of properties, a trigger, a sequence of actions, and the data collected or created.

**Flow properties**

The flow properties information about the flow.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the flow</td>
</tr>
<tr>
<td>Protection</td>
<td>Choose whether the flow is read only by choosing from None or Read-only</td>
</tr>
<tr>
<td>Application</td>
<td>Select an application for the flow. This property is set when creating the flow and cannot be changed afterwards.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the flow.</td>
</tr>
<tr>
<td>Run As</td>
<td>Choose whether the flow runs as System User or the user who initiates the session.</td>
</tr>
</tbody>
</table>

**Triggers**

The trigger specifies the conditions that start the flow. When the trigger condition is true, the system starts the flow.

Flow Designer supports record-based, schedule-based, and application-based trigger types. For detailed descriptions of trigger types, see Flow trigger types.
Actions

Within **Actions**, flow designers can add actions, flow logic, subflows, or other flows.

Each action is a set of reusable business logic that produces a specific outcome when provided with its input values. Flow designers configure actions by specifying where they go in a flow sequence and by selecting the data they use as input values. As a flow runs, actions earlier in the sequence generate outcomes or output values that become available as data to actions later in the flow.

By default, the system provides a collection of core actions that can be added to any flow. Core actions cannot be viewed or edited from the Action Designer interface. Some applications include spokes which add application-specific flows and actions. Spoke actions are typically read-only but can be copied and customized. Developers may also create their custom actions from the Action Designer interface.

Flow data

Flows store any data gathered or generated as variables in the **Data** pane. Each variable has its own pill that Flow designers can use to drag the variable value to an action input or output. Flow Designer generates the pill name based on the contents and its data type. The system specifies the variable data type next to the pill.

Example flow data

Flow logic

Flows may contain *flow logic* to specify conditional or repeated actions. The system provides these flow logic options.

For detailed descriptions of flow logic types, see **Flow logic**.
Testing flows

After adding a trigger and one or more actions, flow designers can test a flow. Testing a flow sets the trigger conditions to true and runs all actions. For flows that have record-based triggers, flow designers may specify an existing test record to use as input. Flow designers should always test flows on non-production instances containing relevant demonstration data since testing a flow creates or changes records on the instance.

Flow execution details

The system generates flow execution records, log messages, and reports for each flow run. The flow context is a related record containing the current state and runtime values of the flow. The system generates a context record each time a flow is run.

Roles

To access Flows, a user must have the flow_designer or admin roles.

Design considerations

Create a subflow when you only want a flow to run from a script

A flow runs whenever its trigger conditions are met. If you want a flow to run only when it is called from a script, create a subflow instead. Since a subflow has no trigger conditions, it will only run when called by another flow or a script call.

Use flow logic or a schedule-based trigger to control flow timing

To pause a flow for a specific duration, use Wait for a duration flow logic. To run a flow at a specific time, use a schedule-based trigger. Avoid using the gs.sleep() method to wait within a flow.

More Actions

Click the More Actions ( ) button to access additional options for the flow.

Stages

Access the stages for a flow.

Manage flow catalog variables

Manage the catalog variables available to Service Catalog-triggered-flows.

Copy flow

Create a copy of the open flow in an application you specify.

Configurations

Enable or disable the Show draft actions, Show triggered flows, and Show store spokes options.

Code Snippet
Generate a code snippet to call a specific flow, subflow, or action.

**Manage security**

Enable or disable the **Callable by Client API** option.

**Flow trigger types**

The trigger specifies the conditions that start the flow. When the trigger condition is true, the system starts the flow.

**Record triggers**

Follow these design considerations when creating record triggers.

**Add conditions to only start record flows when needed**

Use conditions to specify what record values start your flow. Starting a flow only when needed consumes fewer system resources than starting a flow, pausing it, and waiting to resume the flow until a specific record condition applies. Instead of creating a flow that starts with a Wait for condition action, redesign the flow to include the wait condition as part of the record trigger.

**Create unique filter conditions for record triggers on the same table**

To prevent flows from overwriting each other, create unique filter conditions for each flow running on the same table. If multiple flows on the same table have the same filter, there is no way to know the order in which the flows will run.

**Ignore records added or updated by import and update sets**

Record triggers ignore records added or updated by applying an update set or importing an XML file. These operations apply to the entire application or table rather than an individual record.

**Replace record triggers on Service Catalog tables with Service Catalog application triggers**

Flow Designer no longer displays Service Catalog tables as options for record triggers. Instead, create flows that use the Service Catalog application trigger type.

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>Starts a flow when a record is created in a specific table.</td>
</tr>
<tr>
<td>Trigger</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Updated</td>
<td>Starts a flow when a record is updated in a specific table. Requires selecting when to run the flow.</td>
</tr>
<tr>
<td></td>
<td>• <strong>For each unique change</strong>: Triggers the flow for every unique change, even if the flow is currently running.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Once</strong>: Triggers the flow once for the life of the record.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Only if not currently running</strong>: Triggers the flow for every unique change if the flow is not currently running. This behavior is the <strong>Always</strong> option in previous releases.</td>
</tr>
</tbody>
</table>

**Note:** Flows that have a record trigger that runs **For each unique change** can produce recursions when run in a non-interactive session. When such flows make a change to the trigger record, the change meets the flow trigger conditions and causes a recursion.

| Created or Updated      | Starts a flow when a record is either created or updated in a specific table. Requires selecting when to run the flow.                                                                                     |
|                        | • **For each unique change**: Triggers the flow for every unique change, even if the flow is currently running.                                                                                             |
|                        | • **Once**: Triggers the flow once for the life of the record.                                                                                                                                              |
|                        | • **Only if not currently running**: Triggers the flow for every unique change if the flow is not currently running. This behavior is the **Always** option in previous releases. |

**Note:** Flows that have a record trigger that runs **For each unique change** can produce recursions when run in a non-interactive session. When such flows make a change to the trigger record, the change meets the flow trigger conditions and causes a recursion.

**Note:** Flows including approval actions should only run the trigger once.

**Scheduled triggers**

Use scheduled triggers to start a flow after a specific date and time or repeatedly at regular intervals.

**Note:** Because flows are processed asynchronously, a flow with a scheduled trigger may not run at the exact time its trigger conditions were met. For example, if a scheduled flow is triggered during...
core business hours, the system may have to process other events in the queue before it can run the scheduled flow.

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>Starts a flow at a specific time every day.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Starts a flow at a specific time every week.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Starts a flow at a specific time every month.</td>
</tr>
<tr>
<td>Run Once</td>
<td>Starts a flow once at a specific time but does not repeat. If you select a past date or time, the system schedules the flow to run as soon as possible.</td>
</tr>
<tr>
<td>Repeat</td>
<td>Starts a flow at regular intervals you define.</td>
</tr>
</tbody>
</table>

Application triggers

Use application triggers to start a flow when application-specific conditions are met.

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MetricBase</td>
<td>Starts a flow when a MetricBase trigger is met. Requires the MetricBase application. For more information, see Create a flow with a MetricBase trigger.</td>
</tr>
<tr>
<td>Service Catalog</td>
<td>Starts a flow from a Service Catalog item request. For more information, see Create a flow with a Service Catalog trigger.</td>
</tr>
</tbody>
</table>

Inbound email triggers

Start a flow when your instance receives an email.

Inbound email flows take priority over inbound email actions. If you create flows with inbound email triggers, emails are first processed by the inbound email triggers before they are processed by inbound email actions.

With inbound email actions, you don't have full control over email attachment handling or assigning the target record of an email. When you create a flow with an inbound email trigger, you can perform these actions with the Move Email Attachments to Record action and the Associate Record to Email action. For greater control over email attachments, you can also use the Look up email attachments action to access a specific attachment as a data pill.

Although you can process an inbound email with multiple inbound email actions, you can't process an inbound email with multiple flows by default. Additional configuration is required. For information on how to stop processing in inbound email actions, see Specifying the inbound email processing order.

For more information on running multiple flows on an inbound email, see Allow multiple triggers to process an inbound email.

The following diagram shows how inbound emails are processed by inbound email triggers. After the email has been classified as a reply, forward, or new email, the system tries to match the email to an active inbound email trigger. If the email meets the conditions of an inbound email trigger, the flow runs. If the flow issues stop processing, the email is finished being processed. If the flow does not issue stop
processing, the system tries again to match the email to an active inbound email trigger. If at any point the email does not match an active inbound email trigger, the system tries to match the email with an active inbound email action instead.

Processing emails with inbound email triggers

**Note:** With other types of flows, you can choose to run as a system user or the user who initiates the session. However, inbound email flows always run as the sender of the inbound email. If the system does not recognize the sender, inbound email flows will run as the Guest user. The actions
of inbound email flows are limited by user ACL restrictions. To test access controls for an inbound email flow, impersonate a typical inbound email user and manually trigger the flow.

Advanced options

Specify the user session requirements needed to start a flow with **Advanced Options**.

When to run the flow

Determine the type of session that can trigger the flow, and whether to run the flow when triggered by certain users.

Interactive session options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Only Run for Non-Interactive Session        | Flow that is only triggered in non-interactive sessions. 
See [Non-interactive sessions](#). |
| Only Run for User Interactive Session       | Flow that is only triggered in interactive sessions.                        |
| Run for Both Interactive and Non-Interactive Sessions | Flow that is triggered in all sessions.                                     |

**Note:** Flows that have a record trigger that runs **For each unique change** can produce recursions when run in a non-interactive session. When such flows make a change to the trigger record, the change meets the flow trigger conditions and causes a recursion.

User options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not run if triggered by the following users</td>
<td>Flow that does not trigger for a selected list of users. Click the Add User icon to add users to the list.</td>
</tr>
<tr>
<td>Only run if triggered by the following users</td>
<td>Flow that triggers only for a selected list of users. Click the Add User icon to add users to the list.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Run for any user</td>
<td>Flow that runs for any user.</td>
</tr>
</tbody>
</table>

**Where to run the flow**

Determine whether to run the flow in the background or in the current session.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run flow in background (default)</td>
<td>Flow that runs asynchronously in the background. Use this option for flows that do not require immediate updates and to allow other system processes to run at the same time.</td>
</tr>
<tr>
<td>Run flow in foreground</td>
<td>Flow that runs synchronously in the current session. Use this option to provide immediate updates to an end user. For example, if a flow opens a task after the previous task closes, use this option to open the next task immediately after a user closes one.</td>
</tr>
</tbody>
</table>

**Note:** Running a flow in foreground may block the current session thread and prevent user input until the flow finishes. Avoid running flows in the foreground when they contain actions that cannot be interrupted, such as actions that run script. Actions or flow logic that pause a flow will not block a session.

**Create a flow**

Automate a process to run one or more actions when a trigger condition occurs.

- Set up an application in Guided Application Creator to store Flow Designer content.
- Role required: flow_designer or admin

Users with flow_designer or admin role should know the application table structure and be aware of any existing business logic associated with the target tables of a flow or subflow. Be sure to disable any conflicting business rules or workflows before creating a flow or subflow.

Creating a custom application to contain your Flow Designer content enables you to deploy the application using the application repository or the ServiceNow Store.

1. Navigate to **Flow Designer > Designer**.
2. Click **New > New Flow**.
3. On the form, fill in the fields.

**Flow Properties form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify your flow. The system computes the internal name of the flow from the name.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope to create your flow in. Global is the default.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of your flow.</td>
</tr>
</tbody>
</table>
4. Click **Submit**.
   The system displays the Flow Designer page.

5. Add a trigger.
   a) From the Trigger list, select the type of trigger.
      For more information on trigger types, see **Flow trigger types**.
      The system displays a set of fields depending on the type of trigger that you’ve selected.
   b) To specify the trigger, fill in the fields.
      For a record-based trigger, for example, fill in the table and conditions.
   c) Click **Done**.

6. To add actions, flows, subflows, or flow logic, click **Select to add an Action, Flow Logic, or Subflow**.
   a) Select an option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Select the desired action. Flow Designer includes a set of Actions available to flows and subflows. Alternatively, user with the action_designer role can create additional actions to add to flows. The IntegrationHub and spoke plugins install additional actions. To add draft actions from the More Actions menu, set Show draft actions to true. To view spokes available in the ServiceNow Store, set Show store spokes to true from the More Actions menu.</td>
</tr>
<tr>
<td>Flow Logic</td>
<td>Select an option to specify conditional or repeated operations.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Subflow</td>
<td>Select a published subflow and define input values. In addition to adding a subflow as a flow action, you can enable the <strong>Show triggered flows</strong> option from the More Actions menu to select an activated flow and define the required inputs. Running a triggered flow ignores its trigger conditions and runs all actions.</td>
</tr>
</tbody>
</table>

To change the order of an action in a flow, drag the handle on the left side of the action to the desired location.

The system displays a set of fields depending on the option selected.

b) To configure the action, flow, or subflow, fill in the fields.

c) Click **Done**.

d) Repeat adding actions until complete.

7. Click **Save**.
Flow Designer saves a draft of the flow, trigger, and actions.

• Test your flow until it is ready to activate.

    **Note:** The system only triggers active flows.

• Transfer your flow to another instance.

    • **Deploy** your flow from the application repository when your application is complete and ready for release.
    • **Transfer** your flow from an update set XML file when you want to test the flow on another instance. When you save a flow, Flow Designer generates a single update set file containing its subflows and actions.

**Activate Flow Designer support for Service Catalog**

To activate this feature, activate the Flow Designer support for the Service Catalog plugin (com.glideapp.servicecatalog.flow_designer). This plugin activates related plugins if they are not already active.

Role required: admin

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.

    You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

    **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: **Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>**.

Create a flow with a Service Catalog trigger.
Create a flow with a MetricBase trigger

Start a flow when a MetricBase trigger is met. MetricBase triggers track time series data and can monitor when a threshold is reached, when a trend is detected, or when a system stops reporting data.

Role required: flow_designer or admin

MetricBase triggers are not available on the base system. The MetricBase application requires a separate subscription and must be activated by ServiceNow personnel.

1. Navigate to Flow Designer > Designer.
2. Click + New > New Flow.
3. Define the flow properties.
   For more information, see Create a flow.
4. In the Trigger section, add a trigger and select MetricBase.
5. Complete the trigger fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MetricBase Trigger</td>
<td>Select or create a MetricBase trigger record to start the flow. For types of MetricBase triggers, see MetricBase triggers.</td>
</tr>
<tr>
<td>Table</td>
<td>Read-only table that contains the metric.</td>
</tr>
<tr>
<td>Condition</td>
<td>Click Add filters to set field-based conditions that determine when the flow runs.</td>
</tr>
<tr>
<td>Condition Script</td>
<td>Define a script in the Additional MetricBase Trigger Filtering and Moderation table to prevent duplicate metric events from re-triggering a flow. For example, if a metric hovers at a defined trigger threshold, create a script that defines whether to run the flow once when the metric is met, or every time the triggering threshold is exceeded.</td>
</tr>
</tbody>
</table>

6. Add actions, subflows, and flow logic to the flow.
7. Test the flow. Once behaving as desired, activate the flow.
   For more information, see Test a flow and Activate a flow.

The MetricBase application monitors time series data on the Now Platform. When the selected trigger is met, the flow runs.

Create a flow with a Service Catalog trigger

Start a flow when a Service Catalog item is requested to automate the fulfillment process. To activate this feature, activate the Flow Designer support for the Service Catalog plugin (com.glideapp.servicecatalog.flow_designer). This plugin activates related plugins if they are not already active.

- Role required: flow_designer or admin
- Activate the Flow Designer support for the Service Catalog plugin (com.glideapp.servicecatalog.flow_designer).

Unlike a record trigger which runs on all records in a table, the Service Catalog trigger runs on all catalog item requests for a specific item when the catalog item is configured to run a specific flow. For example, you can define a flow that runs every time there is a request for a tablet. The requested item becomes the flow trigger record.

1. If not already created, create the catalog item to associate with the flow.
   a) Navigate to Service Catalog > Catalog Definition > Maintain Items.
      The Catalog Items [sc_cat_item] table opens.
   b) Click New.
c) Complete the fields.
For a detailed description of catalog item fields, see Create or edit a catalog item.

**Note:** If you plan to add stages to your flow, verify that there is not an existing workflow associated with the item that also has stages. Clear the values of the **Workflow** and **Execution Plan** fields to prevent conflicting stages from reporting to the requested item stage field.

2. Create the flow to associate with the catalog item. When triggered, this flow processes the catalog item request.
   a) Navigate to **Flow Designer > Designer**.
   b) Click **+ New > New Flow**.
   c) Define the flow properties.
      For more information, see Create a flow.
   d) In the Trigger section, add a trigger and select **Service Catalog**.
   e) Optional: Create flow-specific catalog variables available only to flow actions. See Create flow Service Catalog variables.
   f) Add actions, subflows, and flow logic to the flow.
      Some actions enable you to manage catalog items. For example, the Create Catalog Task action generates a task for the requested item, and the Get Catalog Variables action enables you to access catalog variables as data pills in the flow. See Create Catalog Task action and Get Catalog Variables action.
   g) Optional: Add stages to the flow to report progress to the requester.
      See Flow Designer stages.
   h) Test the flow. Once behaving as desired, activate the flow.
      For more information, see Test a flow and Activate a flow.

3. Add the flow to the **Flow** field of the catalog item you created.
   a) Navigate to the catalog item.
   b) In the **Flow** field, select the flow you created.

   **Note:** The **Flow** field only displays flows with a Service Catalog trigger.
   c) Click **Update**.

When the catalog item is requested, the associated flow triggers and runs the actions.

**Create flow Service Catalog variables**

Create Service Catalog variables that are only available to a specific Service Catalog-triggered-flow. Flow-specific variables are available to catalog tasks and actions in the flow.

Role required: flow_designer or admin

To activate this feature, activate the Flow Designer support for the Service Catalog plugin (com.glideapp.servicecatalog.flow_designer). This plugin activates related plugins if they are not already active.
Flow Service Catalog variables display in the Catalog Variables field of the Create Catalog Task and Get Catalog Variables actions. They display in the Flow:variablename format and are only available to the flow in which they are defined.

For more information about Service Catalog actions, see Create Catalog Task action and Get Catalog Variables action.

1. Open or create a flow with a Service Catalog trigger.
2. Click and select Manage flow catalog variables. The Flow catalog variables table opens.
3. Click New to add a new variable available to the flow.
4. Complete the form.

Variable form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The variable type that you want to create.</td>
</tr>
<tr>
<td>Application</td>
<td>Read-only field that indicates which applications can use this variable.</td>
</tr>
<tr>
<td>Catalog item</td>
<td>Catalog item using the variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box to make the variable mandatory as part of the ordering process.</td>
</tr>
<tr>
<td>Note:</td>
<td>This behavior is applicable only on page load, and can be changed via client APIs.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to make the variable available for use</td>
</tr>
<tr>
<td>Selection Required</td>
<td>Check box to require users to select the check box variable. For example, use this option to require users to select an I agree check box for an agreement form. If users try to submit the agreement form without selecting the check box, an alert message is displayed to tell users that they must select the check box.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the variable is placed on the page for the catalog item. The variables are organized from top to bottom from least to greatest order value. For example, a variable with an order value of 1 is placed above other variables with higher-order values.</td>
</tr>
<tr>
<td>Global</td>
<td>If selected, the variable is available for all catalog tasks within service catalog workflows or execution plans by default. If deselected, the variable must be associated with individual catalog tasks.</td>
</tr>
<tr>
<td>Map to field</td>
<td>Maps the variable to a specific field on the table for the record producer. This field appears if the variable belongs to a record producer.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Field that the variable maps to. This field appears if the variable belongs to a record producer.</td>
</tr>
<tr>
<td>Record producer table</td>
<td>Table that the record producer creates a record in. This field appears if the variable belongs to a record producer.</td>
</tr>
<tr>
<td>Question</td>
<td>Question to ask users ordering the catalog item.</td>
</tr>
<tr>
<td>Name</td>
<td>A name to identify the question.</td>
</tr>
<tr>
<td>Note: If this field is empty, its value is auto-populated based on the Question field for all variable types except break, container split, and container end.</td>
<td></td>
</tr>
<tr>
<td>Tooltip</td>
<td>Tooltip text to display when users point to the variable. Enter a brief note to describe the purpose of the 'Question'.</td>
</tr>
<tr>
<td>Example text</td>
<td>Hint that is displayed in the question field before a user enters a value.</td>
</tr>
<tr>
<td>Applicable for the following variables:</td>
<td></td>
</tr>
<tr>
<td>• IP Address</td>
<td></td>
</tr>
<tr>
<td>• Email</td>
<td></td>
</tr>
<tr>
<td>• URL</td>
<td></td>
</tr>
<tr>
<td>• Single Line Text</td>
<td></td>
</tr>
<tr>
<td>• Wide Single Line Text</td>
<td></td>
</tr>
<tr>
<td>• Multi Line Text</td>
<td></td>
</tr>
<tr>
<td>• Date</td>
<td></td>
</tr>
<tr>
<td>• Date/Time</td>
<td></td>
</tr>
<tr>
<td>Annotation</td>
<td>If selected, displays the help text and instructions for the variable.</td>
</tr>
<tr>
<td>Note: It is not available for break and check box variables. Help text and instructions are not available for a variable set.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Always Expanded</td>
<td>If selected, the Help text and Instructions field value are expanded by default when the catalog item page loads. This check box appears only when the Show help check box is selected.</td>
</tr>
<tr>
<td>Help tag</td>
<td>If the Always Expanded check box is deselected, click the value specified in this field to display the Help text and Instructions field values.</td>
</tr>
<tr>
<td>Help text</td>
<td>Help information for a service catalog variable. This field is not applicable for Break, CheckBox, Container End, Container Split, Macro, and UI Page variables.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Information that requires rich text formatting or adding images to support help information. Note: For HTML tables, use sizes that are within the width of the variable.</td>
</tr>
</tbody>
</table>

**Type Specifications** (The fields in this section vary for each variable type)

<p>| Variable Width      | Width for the variable on the catalog item page, to specify what percentage of the screen size that it can span. For details, see Configure a default width for service catalog variables. This field appears for all variable types except for break, container end, container start, container split, container layout, and label variables. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice direction</td>
<td>The direction in which the choice list is arranged.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Across</strong>: Arranges choices horizontally.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Down</strong>: Arranges choices vertically.</td>
</tr>
<tr>
<td></td>
<td>This field appears for lookup multiple choice variables.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The selected direction is also applicable in Service Portal.</td>
</tr>
<tr>
<td>Choice field</td>
<td>Table field to populate options for the variable.</td>
</tr>
<tr>
<td></td>
<td>If no choices are defined for a field, then the variable loads field-related distinct values from</td>
</tr>
<tr>
<td></td>
<td>the table.</td>
</tr>
<tr>
<td></td>
<td>This field appears for select box variables.</td>
</tr>
<tr>
<td>Choice table</td>
<td>Table with values to populate in the <strong>Choice field</strong>.</td>
</tr>
<tr>
<td></td>
<td>This field appears for select box variables.</td>
</tr>
<tr>
<td>Do not select the first choice</td>
<td>Check box to leave all options for the variable cleared on the catalog item page.</td>
</tr>
<tr>
<td></td>
<td>If this check box is selected, the first choice for the variable selected by default.</td>
</tr>
<tr>
<td></td>
<td>This field appears for multiple choice and numeric scale variables.</td>
</tr>
<tr>
<td>Dynamic ref qual</td>
<td>Dynamic qualifier. Select a dynamic filter to run a query against the reference field.</td>
</tr>
<tr>
<td></td>
<td>This field appears for reference variables when <strong>Use reference qualifier</strong> is set to Dynamic.</td>
</tr>
<tr>
<td>Include none</td>
<td>Check box to include the <strong>None</strong> option in a list of choices.</td>
</tr>
<tr>
<td></td>
<td>This field appears for lookup multiple choice, lookup select box, multiple choice, and select box</td>
</tr>
<tr>
<td></td>
<td>variables.</td>
</tr>
<tr>
<td>Layout</td>
<td>Layout for a container, whether one or two columns.</td>
</tr>
<tr>
<td></td>
<td>This field appears for container start variables.</td>
</tr>
<tr>
<td>List table</td>
<td>Table with the values for the list collector. The table should have a display column specified.</td>
</tr>
<tr>
<td></td>
<td>This field appears for list collector variables.</td>
</tr>
<tr>
<td>Lookup from table</td>
<td>Table from which values are obtained for users to select. The values from this table are populated</td>
</tr>
<tr>
<td></td>
<td>in the <strong>Lookup value field</strong>.</td>
</tr>
<tr>
<td></td>
<td>This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lookup value field</td>
<td>Field in the lookup table that populates options for the variable. This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Lookup label field(s)</td>
<td>Comma-separated list of fields in the lookup table whose values are used to display options. This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Lookup price field</td>
<td>Field in the lookup table whose value is used to modify the price of the item being ordered. This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Lookup recurring price field</td>
<td>Field in the lookup table whose value is used to modify the recurring price of the item being ordered. This field appears for lookup multiple choice and lookup select box variables.</td>
</tr>
<tr>
<td>Macro</td>
<td>UI macro to insert into the catalog item. This field appears for macro, macro with label, and UI page variables.</td>
</tr>
<tr>
<td>Summary macro</td>
<td>Applicable only for Marco, and Macro with Label type variables.</td>
</tr>
<tr>
<td>Widget</td>
<td>Applicable only for Marco, and Macro with Label type variables.</td>
</tr>
<tr>
<td>Price if checked</td>
<td>Price of the item. This field appears for check box variables.</td>
</tr>
<tr>
<td>Recurring price if checked</td>
<td>Price that increments for the item, when the user requests more than one order of the item. For more information about prices and recurring prices, see Using variables for price setup.</td>
</tr>
<tr>
<td>Reference</td>
<td>Reference table for the variable. The table should have a display column specified. This field appears for reference variables.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Reference qual               | Qualifiers to restrict data that is available in the field.  
Supports reference qualifiers and advanced reference qualifiers.  
Returns all matching results (no maximum). |
| Reference qualifier condition| Options to build conditions.  
This field appears for reference variables when Use reference qualifier is set to Simple. |
| Scale max                    | Highest value on the scale of available options for the variable.  
This field appears for numeric scale variables. |
| Scale min                    | Lowest value on the scale of available options for the variable.  
This field appears for numeric scale variables. |
| Unique values only           | Check box to require a unique value for the field.  
When this check box is selected, two records cannot have the same value for that field.  
This field appears for lookup multiple choice, lookup select box, and select box variables. |
| Use confirmation             | Check box to prompt users to reenter data to verify their entries.  
This field appears for masked variables. |
| Use encryption               | Check box to store the answer in encrypted format in the database. If not encrypted, the answer is stored in plain text format. Encryption uses Triple DES with system encryption.  
This field appears for masked variables. |
| Use reference qualifier      | Type of qualifier to use.  
This field appears for reference variables. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validation Regex</td>
<td>Regular expression that validates the variable value. This field is displayed only for Single Line Text and Wide Single Line Text variable types. To define regular expressions, see #unique_849.</td>
</tr>
</tbody>
</table>
| Note:                | • This field is also applicable in Service Portal.  
• The max_length attribute value is valid even when the validation regex is set.  
• You cannot add a catalog item with regex validation errors to the wishlist. |
| Default Value         | Default value for the variable.                                                                                                                                                                             |
| Variable attributes   | Attributes for this variable.                                                                                                                                                                               |
| Permission            | If no role is specified in this tab for the read, write, or create actions, all users who can access the catalog item can perform these actions irrespective of their role. For example, if no role is specified for the Write roles field, all users who can access the catalog item can edit the variable value in the variable editor.  
A user with a role that does not match any of the following roles cannot set variable values even through scripting.  
These roles are not available for Label, Break, Container Split, Container End, Macro, Macro with Label, and UI Page variables. |
| Read roles            | Roles that can view the variable before or after requesting the catalog item or record producer. Only a user with the roles specified in this field can view the variable.                                           |
| Write roles           | Roles that can edit the variable in the variable editor after requesting the catalog item or record producer. If a user does not have the roles specified in this field, the variable is read-only in the variable editor.         |
| Create roles          | Roles that can create values for the variable before requesting the catalog item or record producer. If a user does not have the specified role, the variable is read-only before requesting the catalog item or record producer. |
| Availability          | If selected, the variable is visible in the item form before ordering the item, in VEditor after ordering the item, and in the cart view of the item.                                                        |
| Visible on Bundles    | If selected, the variable is visible when the item is added to a bundle.                                                                                                                                     |
Field | Description
--- | ---
Visible on Guides | If selected, the variable is visible when it is added to an order guide, or when it is added to a catalog item that is included in the order guide.  
**Note:** If an order guide has too many items and variables, consider clearing this check box on as many items as possible, to improve loading performance on order guides.

Visible on Summaries | If selected, the variable is visible on any variable summarizer of the catalog item.  
In Service Portal, the variable is visible in the RITM ticket page and the Approval page.  
In Now Mobile, the variable is visible in the RITM and the Approval records.

5. Click **Submit**.

Access the variable in the flow by adding a Create Catalog Task or Get Catalog Variables action.

**Create a flow with an inbound email trigger**

Start a flow when your instance receives an email.

Role required: flow_designer or admin

1. Navigate to **Flow Designer > Designer**.
2. Click **+ New > Flow**.
3. Define the flow properties, and then click **Submit**.  
   For more information, see **Create a flow**.
4. In the Trigger section, click the plus icon + to add a trigger.
5. Select **Inbound Email**.
6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email conditions</td>
<td>Conditions to qualify which emails start your flow. The condition builder uses fields from the Email [sys_email] table. For example, to trigger a flow for an inbound email in which a user replies to a system notification, set the condition to [Receive type] [is] [Reply].</td>
</tr>
<tr>
<td>Reply Record Type</td>
<td>Table that is associated with the target email. For example, to trigger a flow from a reply email that a user sends from an incident record notification, select Incident [incident].</td>
</tr>
</tbody>
</table>

7. Click **Done**.
8. Add actions, subflows, and flow logic to the flow.
9. Optional: Add stages to the flow to report progress to the requester.  
   See **Flow Designer stages**.
10. Test the flow. If the test is successful, activate the flow.
   For more information, see Test a flow and Activate a flow.

When an inbound email meets the conditions that you set, the associated flow triggers and runs the actions.

*Allow multiple triggers to process an inbound email*

Configure Flow Designer to allow an inbound email to be processed by multiple inbound email triggers in a specific order.

Role required: admin

Although you can process an inbound email with multiple inbound email actions, you can’t process an inbound email with multiple flows by default. You can add a system property to let process owners use multiple triggers to process an inbound email.
Warning: Allowing multiple triggers to process an inbound email may increase maintenance and decrease system performance.

1. Add a property with the following settings:
   - Name: glide.hub.flow.inbound_email_trigger.show_advanced
   - Type: true | false
   - Value: true

   After you activate the system property, the Order and Stop processing fields appear on the inbound email trigger, as shown in the following figure.

   ![Inbound Email Trigger Image]

2. Create multiple flows with an inbound email trigger.
   For more information, see Create a flow with an inbound email trigger.
3. Specify the processing order for each of the inbound email flows:
   a) Open each flow and enter a value in the Order field.
      To give the flow higher priority over other flows, enter a lower number.
   b) Enable or disable stop processing for each flow in your sequence.
      To allow an inbound email to be processed by the next flow in your sequence, clear the Stop processing option.
      To end the sequence on a particular flow, leave the option selected in that flow.

Test a flow
Before activating a flow so other users can access it, test to make certain it works the way you expect.
Role required: flow_designer or admin. Save the flow.
1. If necessary, navigate to Flow Designer > Designer, then double click the row for the flow you want to test.
2. Click Test.
   The system displays the Test flow dialog. The contents of the Test flow dialog depend on the type of trigger: Data or Schedule. If the trigger is a Data trigger, the dialog asks for a record to use for the test.
3. If the trigger is a Data trigger, select a record to use for the test.
   When you test a flow, the system does not execute the trigger. In other words, for a trigger that fires when a record is added to a particular data, the test does not create a new record. It behaves as if a record was created. By selecting a record on the Test flow dialog, you are asking the system to act as if that record was just created.

Activate a flow
Activate a flow to make it available to other users.
Role required: flow_designer or admin
When you save a flow, you can test it, but no other users on the instance can see or run it. To make the flow available to other users, activate it.
1. Navigate to Flow Designer > Designer.
2. Double click the row for the flow you want to display it on the flow designer page.
3. Click Activate.

Edit a flow
Edit an existing flow.
Role required: flow_designer or admin
1. If necessary, navigate to Flow Designer > Designer, then double click the row for the flow you want to edit.
   The system displays the flow designer page.
2. Take the appropriate actions to edit the flow.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the flow name or description</td>
<td>Click Edit Properties, enter the values you want into the appropriate fields, then click Update.</td>
</tr>
</tbody>
</table>

Note: You cannot change the scope of an automationHub flow after you have saved it.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To edit the trigger</td>
<td>Click the trigger description, fill in the fields as desired, then click <strong>Done</strong>.</td>
</tr>
<tr>
<td><strong>Note</strong>: Modifying triggers can result in the deletion of referenced action configurations.</td>
<td></td>
</tr>
<tr>
<td>To edit an existing action</td>
<td>Click the action description, fill in the fields as desired, then click <strong>Done</strong>.</td>
</tr>
<tr>
<td>To add a new action</td>
<td>Click the plus icon in the ACTION section then proceed as you would for adding an action to a new flow.</td>
</tr>
</tbody>
</table>

3. **To save your changes, click** **Save**.

**Delete a flow**

Delete a flow that you no longer need.

Role required: **flow_designer** or **admin**

You can only delete records that are in the same application scope as the current session.

1. If necessary, navigate to **Flow Designer > Designer** to display the flow designer page.
2. Check the selection box for the row corresponding to the flow you want to delete.
3. Click **Actions on selected rows . . .**, then click **Delete**.

**Allow flow designers to dynamically set field values**

Enable flow designers to dynamically set field values when adding the subflow or action to a flow. For example, allow flow designers to set the priority and short description of a Create Task action.

A dynamic field can only be created in a subflow action or action step that creates or updates a record, such as Create Catalog Task, Create Task, Create Record, and Update Record.

Role required: **admin** or **action_designer**

When creating or updating a record in a subflow action or action step, you can set static or dynamic values. A static value is the same every time a flow runs. A dynamic value allows a flow designer to change it every time a flow runs. For example, setting the Urgency to the static value 1 - High generates an urgent catalog task every time the flow runs.

1. Open an action in Action Designer or a subflow in Flow Designer that you want to create a dynamic value for.
2. Create an input.
   a) In the Label field, enter a label to help flow designers understand the purpose of the field. This is the label for the field when the flow designer adds the subflow or action to a flow. For example, enter Select fields.
   b) In the Type field, select Template Value. Select the table containing the record you will create or update. For example, if you are adding a Create Catalog Task action in a subflow, set the Type to Template Value.Requested Item [sc_req_item].

3. Add an action step or action that will use the template value.
   The action step or action must create or update a record. For example, add a Create Task action to a subflow that will create an incident task.

4. Drag the Template Value data pill into the Field Values or Fields field.

5. Optional: Add static values in addition to the dynamic field by selecting + Add Field Value.

   **Note:** Avoid setting static values that you want flow designers to set from the dynamic field. The flow always uses the static value from the subflow or action step over a value entered from a dynamic field. You can use static values to enforce business policies that you do not want flow designers to change.

When the subflow or action is added to a flow, a flow designer can set field values for the record being created or updated.
View activated flows for a table

View flows with record-based triggers that run on a specific table.

Role required: flow_designer or admin

1. Navigate to a table.
2. Right-click the form header and select **Configure > Flow Designer Flows**.

   The Flows table opens and displays all flows that have been activated to run on the specified table.

Actions

Actions can be added to any flow, enabling process analysts to automate Now Platform features without having to write code.

An action is a reusable operation that enables process analysts to automate Now Platform features without having to write code. For example, the **Create Record** action allows process analysts to generate records in a particular table with particular values when certain conditions occur. Core actions like Create Record require some familiarity with Now Platform tables and fields. Action designers can create application-specific actions to pre-set configuration details. For example, creating a Create Incident Task action ensures that the process analyst uses the correct table and field configuration each time the action is used. You can add application-specific actions by activating the associated spoke.

In Flow Designer, a process analyst adds actions to a flow and defines the configuration options.

Core actions

A core action is a ServiceNow-provided action available to any flow that cannot be viewed or edited from the Action Designer design environment. For example, the **Ask for Approval** action is a core action that allows process analysts to use Now Platform approvals. Flow Designer provides a set of core actions to automate Now Platform processes. You can add application-specific core actions by activating the associated spoke.

Custom actions

Using a core action enables the process analyst to configure the desired behavior within the flow. To create an action with a pre-set configuration, or to define custom configuration options, a subject matter expert can create a custom action in Action Designer.
**Action limit**

By default, flows can have no more than 50 actions. To change the default behavior, increase the value of the `sn_flow_designer.max_actions` system property. However, consider the performance impact that a large flow may have on your instance.

**Add Worknote Link to Context action**

Add a journal field entry containing a link to the current flow context record. Use the link to view the flow execution details of the current flow. You can add a flow context link to any record that has a journal field.

**Roles and availability**

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Set to the table name associated with the record. For example, the Task table.</td>
</tr>
<tr>
<td>Record</td>
<td>The record to be updated. Drag-and-drop a record data pill or use the data pill picker to select a record. For example, the trigger record.</td>
</tr>
<tr>
<td>Journal Field</td>
<td>The journal field to insert the link to the flow context record. For example the work notes field of a task record.</td>
</tr>
<tr>
<td>Additional Comments</td>
<td>The text you want to add to the journal field in addition to the link to the flow context record. For example, the name of the flow run.</td>
</tr>
</tbody>
</table>

**Ask for Approval action**

Request approval for a record with an approval field. You can configure a rule set for an approval, rejection, or cancellation. If a due date is added to an approval, the approval is automatically approved, rejected, or canceled if the approvers have not responded by the designated time.

**Approvals** is a platform feature that enables users or groups to approve or reject a task.

**Roles and availability**

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.
### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Select a record under the data panel and drag the record pill into the Record field. If selecting a table with an approval field already configured, the Approval field is set to the correct field.</td>
</tr>
<tr>
<td>Table</td>
<td>Set to the table name associated with the record.</td>
</tr>
<tr>
<td>Approval field</td>
<td>Select a field from the designated table to use for approval.</td>
</tr>
<tr>
<td>Journal field</td>
<td>Select a field from the designated table to use for journal.</td>
</tr>
</tbody>
</table>
| Rules         | Define the approval and rejection rules. Approval rules determine which users can approve or reject requests, and what happens after approval or rejection. Approval or rejection rules include:  
  - Anyone approves  
  - All users approve  
  - All responded and anyone approves  
  - % of users approve  
  - # of users approve  
  In the field beside the approval rule, add the desired approvers. To add approvers:  
    - Select individual users or groups.  
    - Drag-and-drop or select a field from a record.  
    - ![Select](select_icon.png) to allow a manual approver to process an approval or rejection. A manual approver is a user manually added to the Approvers related list who can then approve the request. For example, you can manually add a subject matter expert to a task to approve the request. To learn more about adding manual approvers, see Generate approvals using the approvers related list.  
  Define rejection rules by adding another OR rule set. When defining approvals, include rejection rules that run when there are no matching approvals. Such rejection rules prevent the flow from remaining in a waiting state. For example, if an approval can be approved by anyone, create a time-based rejection rule in case no one approves it.  
  **Note:** If you set an approval rule with no rejection rule (or vice versa) and the expected approval state is not met, the runtime value will be canceled.  
| Due Date      | Define a due date to ensure that the flow does not remain in a waiting state if the request is not approved or denied.  
  - None: The approval is not dependent on a specific date.  
  - Approve: Automatically approve the step if an action is still pending by the specified date.  
  - Reject: Automatically reject the step if an action is still pending by the specified date.  
  - Cancel: Automatically cancel the step if an action is still pending by the specified date. |
Example

TRIGGER

[Incident] Created or Updated

ACTION

1  Ask For Approval

- **Action**: Ask For Approval
- **Record**: Trigger ▶ Incident Record
- **Table**: Incident [incident]
- **Approval Field**: Approval
- **Journal Field**: Approval history

**Rules**

- **Approve**: When: Anyone approves
  - Trigger ▶ Incident Record ▶ Assigned to ▶ Manager

OR

- **Reject**: When: Anyone rejects
  - Trigger ▶ Incident Record ▶ Assigned to ▶ Manager

- **Due Date**: Approve ▼ if pending by Relative date ▼ 1 Days ▼ From

  - Days schedule: 8-5 weekdays
Output

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval State</td>
<td>State of the approval request</td>
<td>Choice</td>
</tr>
</tbody>
</table>

**Associate Record to Email action**

Associate a record with an Email [sys_email] record so that you can track which record is affected by the email.

**Roles and availability**

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Record</td>
<td>Email [sys_email] record that the Target Record associates with.</td>
</tr>
<tr>
<td>Target Record</td>
<td>Record to associate to the email record</td>
</tr>
</tbody>
</table>

**Output**

- This action updates the **Target** field on the Email [sys_email] record.

**Example**

In the following example, a process owner adds the Associate Record to Email action under an inbound email trigger. The user has also added a Create Catalog Task action in the flow. In the **Email Record** field, the user selects to associate a record to the email that triggered the flow. In the **Target Record** field, the user selects to associate the Catalog Task [sc_task] record that is created in the Create Catalog Task action.
Create Catalog Task action

Creates a record in the Catalog Task [sc_task] table associated to a requested item in the Requested Items [sc_req_item] table. Adds the catalog task record as data to be used in the flow.

Roles and availability

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.
### Fields

<table>
<thead>
<tr>
<th>Fields [Catalog Task]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>The Catalog Task [sc_task] table where the catalog task is created. This value is read only.</td>
</tr>
<tr>
<td>Requested Item [Requested Item]</td>
<td>The requested item record from the Requested Items [sc_req_item] table that this catalog task fulfills.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Short description for the catalog task.</td>
</tr>
<tr>
<td>Fields [Catalog Task]</td>
<td>To add the action to a flow, set fields in the catalog task record to the desired value. For example, to set the Urgency, select <strong>Urgency</strong> and set the desired value.</td>
</tr>
<tr>
<td></td>
<td>If adding the action to a subflow, you can allow flow designers to dynamically set field values.</td>
</tr>
<tr>
<td>Wait</td>
<td>Pauses the flow until this task completes and is no longer active (active=false). Alternatively, you can add a wait condition by dragging-and-dropping a true/false field from the data panel into the <strong>Wait</strong> field. The flow only waits for the task to complete when this field is true.</td>
</tr>
<tr>
<td>Template Catalog Item [Catalog Item]</td>
<td>Select an item from the Catalog Items [sc_cat_item] table to populate the Catalog Variables slushbucket with the associated variables.</td>
</tr>
<tr>
<td>Catalog Variables</td>
<td>Select catalog variables to show on the catalog task form to provide more information or allow the fulfiller to modify the variables. You can define flow-specific variables that are displayed in the Available list. To define flow-specific variables, see Create flow Service Catalog variables.</td>
</tr>
</tbody>
</table>
Example

TRIGGER

[Service Catalog]

ACTIONS

1

Create Catalog Task

Action: Create Catalog Task

Table Name: Catalog Task [sc_task]

Requested Item [Requested Item]: Trigger + Requested Item Record

Short Description: Order from vendor or move from in-stock inventory

Fields [Catalog Task]: Add Field Value

Wait

Template Catalog Item [Catalog Item]: Apple iPhone 5

Catalog Variables

Available

Selected

data_plan

color

storage
carrier
duration

Delete  Cancel  Done
Create Record action

Creates a record on any table. You can dynamically add and configure fields for the record.

Roles and availability

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table from the list.</td>
</tr>
</tbody>
</table>
| Field Values | Set the values of fields in the record to be created. For example, to set the short description to a certain value, select **Short description** and set the desired value.  
If adding the action to a subflow, you can **Allow flow designers to dynamically set field values.** |

Create or Update Record action

Create or update a record in a ServiceNow table using a single action. Update a record that exists, or create a record using the values provided.

Identification of existing records

The Create or Update Record action identifies existing records by searching for matching values in the fields that you select as unique identifiers. For example, you can specify that the short description and priority fields uniquely identify an incident. When the action finds an incident with a matching short description and priority, it updates the matching record rather than creating a new record.

Note:

- If no field is selected as a unique identifier, the action creates a record with the field values provided.
- If more than one record matches the value of the unique identifiers, the action doesn't update any records and displays an error message in the flow execution details.

Roles and availability

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.
### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>Table in which a record is created or updated.</td>
</tr>
<tr>
<td>Fields</td>
<td>Values of fields in the record to be created or updated. If adding the action to a subflow, you can <strong>Allow flow designers to dynamically set field values</strong>. Dynamically set field values can trigger server-side validation rules such as data policies, business rules, and dictionary-defined mandatory fields, but cannot trigger UI policies.</td>
</tr>
<tr>
<td>Determines uniqueness</td>
<td>Option for selecting the field as a unique identifier. This field appears when the required table name and fields are selected.</td>
</tr>
</tbody>
</table>

### Create Task action

Create a task on any ServiceNow task table. After you choose the task table, you can dynamically select the fields to configure the action. Defining the Parent field associates the task to a parent record.

### Roles and availability

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.
# Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a task table.</td>
</tr>
<tr>
<td>• Catalog Task</td>
<td>[sc_task]</td>
</tr>
<tr>
<td>• Change Phase</td>
<td>[change_phase]</td>
</tr>
<tr>
<td>• Change Request</td>
<td>[change_request]</td>
</tr>
<tr>
<td>• Chat Queue Entry</td>
<td>[chat_queue_entry]</td>
</tr>
<tr>
<td>• Feature Task</td>
<td>[release_task]</td>
</tr>
<tr>
<td>• Follow On Task</td>
<td>[cert_follow_on_task]</td>
</tr>
<tr>
<td>• Group approval</td>
<td>[sysapproval_group]</td>
</tr>
<tr>
<td>• Guided Setup Task</td>
<td>[gsw_task]</td>
</tr>
<tr>
<td>• IMAC</td>
<td>[change_request_imac]</td>
</tr>
<tr>
<td>• Incident</td>
<td>[incident]</td>
</tr>
<tr>
<td>• Incident Task</td>
<td>[incident_task]</td>
</tr>
<tr>
<td>• KB Submission</td>
<td>[kb_submission]</td>
</tr>
<tr>
<td>• Orphan CI Remediation</td>
<td>[orphan_ci_remeditation]</td>
</tr>
<tr>
<td>• Private Task</td>
<td>[vtb_task]</td>
</tr>
<tr>
<td>• Problem</td>
<td>[problem]</td>
</tr>
<tr>
<td>• Problem Task</td>
<td>[problem_task]</td>
</tr>
<tr>
<td>• Reclassification Task</td>
<td>[reclassification_task]</td>
</tr>
<tr>
<td>• Recommended Field Remediation</td>
<td>[recommended_field_remediation]</td>
</tr>
<tr>
<td>• RemEDIATE Duplicate Task</td>
<td>[reconcile_duplicate_task]</td>
</tr>
<tr>
<td>• Release Phase</td>
<td>[release_phase]</td>
</tr>
<tr>
<td>• Renew Lease Task</td>
<td>[statemgmt_renew_lease_task]</td>
</tr>
<tr>
<td>• Request</td>
<td>[sc_request]</td>
</tr>
<tr>
<td>• Request new Knowledge Base</td>
<td>[kb_knowledge_base_request]</td>
</tr>
<tr>
<td>• Requested Item</td>
<td>[sc_req_item]</td>
</tr>
<tr>
<td>• Required Field Remediation</td>
<td>[required_field_remediation]</td>
</tr>
<tr>
<td>• Security Case</td>
<td>[sn_ti_case]</td>
</tr>
<tr>
<td>• Security Incident</td>
<td>[sn_si_incident]</td>
</tr>
<tr>
<td>• Security Incident Response Task</td>
<td>[sn_si_task]</td>
</tr>
<tr>
<td>• Security Request</td>
<td>[sn_si_scan_request]</td>
</tr>
<tr>
<td>• Service Order</td>
<td>[sm_order]</td>
</tr>
<tr>
<td>• Service Order Task</td>
<td>[sm_task]</td>
</tr>
<tr>
<td>• Service Task</td>
<td>[service_task]</td>
</tr>
<tr>
<td>• Stale CI Remediation</td>
<td>[stale_ci_remeditation]</td>
</tr>
<tr>
<td>• Standard Change Proposal</td>
<td>[std_change_proposal]</td>
</tr>
<tr>
<td>• Ticket</td>
<td>[ticket]</td>
</tr>
</tbody>
</table>

## Field Values

Set the values of fields in the task to be created. For example, to set the short description to a certain value, select **Short description** and set the desired value. To associate the task with a parent record, define the **Parent** field.

If adding the action to a subflow, you can **Allow flow designers to dynamically set field values**.
### Copy Attachment action

Copies an attachment from the Attachments [sys_attachment] table to a target record.

#### Roles and availability

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.

#### Note:

Server-side validation rules, such as data policies, business rules, and dictionary-defined mandatory fields are enforced. UI policies do not apply.

#### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Attachment Record</td>
<td>Select an attachment record from the Attachments [sys_attachment] table.</td>
</tr>
<tr>
<td>Target Record</td>
<td>Select a record to attach the Source Attachment Record to, or drag a Record data pill from the data pane.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table from the list to select a Target Record.</td>
</tr>
</tbody>
</table>

### Delete Attachment action

Removes one or all attachments associated with a record and deletes the attachment record from the Attachments [sys_attachment] table.

#### Roles and availability

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.

#### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Record</td>
<td>Drag a Record data pill from the data pane to delete one or all attachment records from.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table</td>
<td>Automatically populates with the <strong>Source Record</strong> table.</td>
</tr>
<tr>
<td>Attachment File Name</td>
<td>Enter the name of the attachment file to delete a single attachment associated with the selected record.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If a record has multiple attachments with same name, all matching attachments are deleted.</td>
</tr>
<tr>
<td>Delete All Attachments?</td>
<td>Select to delete all attachments associated with the selected record.</td>
</tr>
</tbody>
</table>

**Delete Record action**

Deletes a record on any table.

**Roles and availability**

- Available as a Flow Designer core action. Users with the `flow_designer` role can add an action to a flow and define configuration details.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>The record to be deleted. Drag-and-drop a record data pill or use the data pill picker to select a record.</td>
</tr>
</tbody>
</table>

**Get Attachments on Record action**

Access the list and count of the attachments associated with the provided source record as data pills in a flow. Use flow logic or scripting to process each attachment in the list of the attachments that the action returns.

**Roles and availability**

Available as a Flow Designer core action. Users with the `flow_designer` role can add an action to a flow and define configuration details.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Entire file name or part of the file name.</td>
</tr>
<tr>
<td>Source Record</td>
<td>Record as a data pill from the data pane or the record that the attachment is associated with.</td>
</tr>
</tbody>
</table>
Get Catalog Variables action

Access ServiceNow® Service Catalog variables as data pills in a flow.

Roles and availability

Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submitted Request</td>
<td>Submitted request from any ServiceNow table.</td>
</tr>
<tr>
<td>[Requested Item]</td>
<td></td>
</tr>
<tr>
<td>Template Catalog Item</td>
<td>Item from the Catalog Items [sc_cat_item] table to populate the Catalog</td>
</tr>
<tr>
<td>[Catalog Item]</td>
<td>Variables list with the associated variables.</td>
</tr>
<tr>
<td>Catalog Variables</td>
<td>Catalog variables to be displayed in the data panel. Select variables or</td>
</tr>
<tr>
<td></td>
<td>single-row variable sets.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For optimal performance, avoid selecting Masked variables.</td>
</tr>
<tr>
<td></td>
<td>You can define flow-specific variables that are displayed in the Available</td>
</tr>
<tr>
<td></td>
<td>list. To define flow-specific variables, see Create flow Service Catalog</td>
</tr>
<tr>
<td></td>
<td>variables.</td>
</tr>
</tbody>
</table>

Get Email Header action

Access an email header value as a data pill in a flow.

Roles and availability

- Available as a Flow Designer core action. Process analysts use the flow_designer role to add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Record</td>
<td>Record from the Email [sys_email] table.</td>
</tr>
<tr>
<td>Target Header</td>
<td>Header from the email record. Upon completion of the action, the header</td>
</tr>
<tr>
<td></td>
<td>value is added as a data pill in the flow.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If multiple headers have the same name, the action gets the</td>
</tr>
<tr>
<td></td>
<td>value of the first header that appears.</td>
</tr>
</tbody>
</table>
Example

In the following example, a process owner adds the Get Email Header action under an inbound email trigger. In the **Email Record** field, the user selects to get an email header from the email that triggered the flow. In the **Target Header** field, the user selects to get the Subject header from the email.

Log action

Logs a message in the Flow Designer log table.

Roles and availability

- Available as a Flow Designer core action. Users with the `flow_designer` role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log level</td>
<td>Level of importance of the log message.</td>
</tr>
<tr>
<td></td>
<td>• Error</td>
</tr>
<tr>
<td></td>
<td>• Warn</td>
</tr>
<tr>
<td></td>
<td>• Info</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Log message</td>
<td>Message to display in the log. Enter text or drag-and-drop data pills into the field.</td>
</tr>
</tbody>
</table>

**Look up email attachments action**

Look up files that are attached to an email so that you can perform an action on the files.

**Roles and availability**

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email record [Email]</td>
<td>Record from the Email [sys_email] table. For example, select the email record from the flow trigger. After you select an email record, the related Email Attachment [sys_email_attachment] record and its fields become available as data pills.</td>
</tr>
</tbody>
</table>

**Output**

- This action generates a list of Email Attachment [sys_email_attachment] records, which list the attachments that are associated with a given email record. To perform an action on an attachment, add flow logic that runs for each Attachment pill under the Email Attachment Record pill. For more information, see For each flow logic.

**Example**

In the following example, a process owner adds the Look up email attachments action under an inbound email trigger. In the Email record [Email] field, the user selects to look up files that are attached to the email that triggered the flow.
Look Up Record action

Look up a record from any table based on defined conditions.

Roles and availability

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table from the list.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions to be met by the returned record.</td>
</tr>
<tr>
<td></td>
<td>When building a condition that looks up the value of a reference field, use a data pill that explicitly provides the Sys ID value. Ensure the condition has the format <code>[reference field][is][Reference type data pill-&gt;Sys ID]</code>. For example, both the Change and Incident tables contain a reference field to the User table. To look up change records where the requester is the caller from an incident record, create the condition <code>[Requested by][is][Trigger-&gt;incident record-&gt;Caller-&gt;Sys ID]</code>.</td>
</tr>
<tr>
<td>Order by</td>
<td>Determines how to sort results when more than one record matches the defined conditions. Select the field you want to use to sort results.</td>
</tr>
<tr>
<td>Sort Type</td>
<td>Select whether to sort alphabetically in ascending or descending order.</td>
</tr>
</tbody>
</table>
**Field** | **Description**
---|---
If multiple records are found | Determines what is returned if more than one record matches the defined conditions.
  - Return only the first record
  - Fail the step

**Example**

**TRIGGER**

**Incident Created or Updated**

**ACTIONS**

1. **Look Up Incident Record**

  **Action** | Look Up Record
  **Table** | Incident [incident]

  **Conditions**

  All of these conditions must be met

  - Active
  - State
  - Short description

  or

  **New Criteria**

  **Order by** | Short description

  **If multiple records are found action** | Return only the first record

**Look Up Records action**

Look up multiple records on any table using defined conditions.
Roles and availability

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table from the list.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions to be met by the returned records. When building a condition that looks up the value of a reference field, use a data pill that explicitly provides the Sys ID value. Ensure the condition has the format <code>[reference field][is][Reference type data pill-&gt;Sys ID]</code>. For example, both the Change and Incident tables contain a reference field to the User table. To look up change records where the requester is the caller from an incident record, create the condition <code>[Requested by][is][Trigger-&gt;incident record-&gt;Caller-&gt;Sys ID]</code>.</td>
</tr>
<tr>
<td>Order by</td>
<td>Select the field you want to use to sort results.</td>
</tr>
<tr>
<td>Sort Type</td>
<td>Select whether to sort alphabetically in ascending or descending order.</td>
</tr>
<tr>
<td>Max Results</td>
<td>Maximum number of results returned.</td>
</tr>
</tbody>
</table>
Example

Lookup Attachment action

Looks up an attachment associated with a record and returns the Attachment Sys ID as a data pill.

Roles and availability

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.

Note: Server-side validation rules, such as data policies, business rules, and dictionary-defined mandatory fields are enforced. UI policies do not apply.
Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Enter the name of the attachment to look up. If the record includes multiple attachments with the same file name, the system returns the first Sys ID encountered.</td>
</tr>
<tr>
<td>Source Record</td>
<td>Drag a Record data pill from the data pane, or select the record that the attachment is associated with.</td>
</tr>
</tbody>
</table>

Move Attachment action

Associates a record from the Attachment [sys_attachment] table with a target record. Removes the attachment from any other associated records.

Roles and availability

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.

Note: Server-side validation rules, such as data policies, business rules, and dictionary-defined mandatory fields are enforced. UI policies do not apply.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Attachment Record [Attachment]</td>
<td>Select an attachment record from the Attachments [sys_attachment] table.</td>
</tr>
<tr>
<td>Target Record</td>
<td>Drag a Record data pill from the data pane to attach the <strong>Source Attachment Record</strong> to.</td>
</tr>
<tr>
<td>Table</td>
<td>Automatically populates with the <strong>Source Record</strong> table.</td>
</tr>
</tbody>
</table>

Move Email Attachments to Record action

Move attachments from an email to a record so that the files are available to your users when they view the record.

Roles and availability

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.
Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Record</td>
<td>Email [sys_email] record to move attachments from.</td>
</tr>
<tr>
<td>Target Record</td>
<td>Record to move attachments to.</td>
</tr>
</tbody>
</table>

Output

- This action updates the Email Attachment [sys_email_attachment] record. The Action field changes to Attached to Target Record.

Example

In the following example, a process owner adds the Move Email Attachments to Record action under an inbound email trigger. The user has also added the Create Catalog Task action in the flow. In the Email Record field, the user selects to move attachments from the email that triggered the flow. In the Target Record field, the user selects to move email attachments to the Catalog Task [sc_task] record that is created in the Create Catalog Task action.

![Diagram of process flow](attachment:process_flow_diagram.png)
Send Email action

Send an email to specified users or groups as an action in a flow.

Roles and availability

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Record</td>
<td>Record that the email is associated to. When a user sends a reply to your email, the target record is updated with the reply email content.</td>
</tr>
<tr>
<td>Table</td>
<td>Table of the target record.</td>
</tr>
<tr>
<td>Include Watermark</td>
<td>Option to apply a watermark to the email that is sent. To include a watermark, you must set a target record.</td>
</tr>
<tr>
<td>To</td>
<td>The main recipients of the email. Enter a list of user email addresses separated by commas or white spaces. You can also drag-and-drop data pills that contain email addresses into the field, such as a User record. For example, if your action involves an incident record and you want to send an email to the group assigned to the incident, drag the [Assignment group] data pill from the data panel.</td>
</tr>
<tr>
<td>CC</td>
<td>Additional recipients copied on this email. Enter a list of user email addresses separated by commas or white spaces. You can also drag-and-drop data pills that contain email addresses into the field.</td>
</tr>
<tr>
<td>BCC</td>
<td>Additional recipients of this email, who are visible only to the sender (blind copied). Enter a list of user email addresses separated by commas or white spaces. You can also drag-and-drop data pills that contain email addresses into the field.</td>
</tr>
<tr>
<td>Subject</td>
<td>Subject of the email. You can enter text or drag-and-drop data pills into the field.</td>
</tr>
<tr>
<td>Body</td>
<td>The content of the message body. You can enter text or drag-and-drop data pills into the field.</td>
</tr>
</tbody>
</table>

Note: Flow Designer does not support the ${URI} parameter for creating a link to a record in the email message body. Instead, consider inserting the information from the record in the email body using data pills, or create a notification step.

Testing the email action

To verify that the email was generated when testing the action, review the email record in the Email [sys_email] table. The Headers field indicates whether the email was successfully generated. For example:
ACL restrictions apply to the Send Email action. If you configured your flow to run as the user who initiates the session, ensure that the user has access control to send email. To test access controls for a Send Email action, impersonate a typical email sender and manually trigger the flow.

**Update Record action**

Update an existing record in a table. You can dynamically add and configure fields for the record.

**Roles and availability**

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>The record to be updated. Drag-and-drop a record data pill or use the data pill picker to select a record.</td>
</tr>
<tr>
<td>Table</td>
<td>Read-only. Set to the table associated with the record.</td>
</tr>
<tr>
<td>Field Values</td>
<td>Set the values of fields in the record to be updated. For example, to set the short description to a certain value, select <strong>Short description</strong> and set the desired value. If adding the action to a subflow, you can <strong>Allow flow designers to dynamically set field values</strong>.</td>
</tr>
</tbody>
</table>

**Wait For Condition action**

Pause a flow until record values match a specific set of conditions.

**Roles and availability**

- Available as a Flow Designer core action. Users with the flow_designer role can add an action to a flow and define configuration details.
### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Drag-and-drop an input record or a record from a previous step.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If this record is deleted while the flow is waiting, the flow stops waiting and continues running.</td>
</tr>
<tr>
<td>Table</td>
<td>Read-only. Set to the table associated with the record.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Select the record values necessary to resume running the flow. For example, if the condition is [State][is][Closed], the flow pauses until the condition is met. Once met, the flow moves on to the next step or action.</td>
</tr>
</tbody>
</table>

### Unsupported tables

The system does not support Wait for Condition for the following tables.

<table>
<thead>
<tr>
<th>Table Category</th>
<th>Table Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit</td>
<td>Sys Audit [sys_audit], Audit Deleted Record [sys_audit_delete], Audit Relationship Change [sys_audit_relation], Audit Roles [sys_audit_role], Audit Relationship Change [sys_audit_relation], Audit Deleted Record [sys_audit_delete]</td>
</tr>
<tr>
<td>Email</td>
<td>Email [sys_email], Email Account [sys_email_account], Email Log [sys_email_log]</td>
</tr>
<tr>
<td>Events</td>
<td>Event [sysevent], Notification [sysevent_email_action], Stationery [sysevent_email_style], Email Template [sysevent_email_template], Inbound Email Actions [sysevent_in_email_action], Slow Event [sysevent_pattern], Event Registration [sysevent_registration], Script Action [sysevent_script_action]</td>
</tr>
<tr>
<td>Import Sets</td>
<td>Import Set [sys_import_set], Import Set Row [sys_import_set_row], Import Set Row Error [sys_import_set_row_error], Transform History [sys_import_set_run], Computer [imp_computer], Notification [imp_notification], Location [imp_location], User [imp_user]</td>
</tr>
<tr>
<td>JRobin</td>
<td>JRobin Database [jrobin_database], JRobin Shard [jrobin_shard], Graph Line [jrobin_graph_line], JRobin Shard Fragments [jrobin_shard_location], Member [jrobin_graph_set_member], Round Robin Archive [jrobin_archive], Round Robin Data Source [jrobin_datasource], Round Robin Definition [jrobin_definition], Round Robin Graph [jrobin_graph], Round Robin Graph Set [jrobin_graph_set]</td>
</tr>
<tr>
<td>Logs</td>
<td>Log Entry [syslog], Service Portal Log Entry [sp_log]</td>
</tr>
<tr>
<td>Table Category</td>
<td>Table Names</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MID Server</td>
<td>MID Server Property [ecc_agent_property], Mid Server Log [ecc_agent_log], Queue [ecc_queue], Configuration [ecc_queue_config], ECC Queue Statistics (by ECC Agent) [ecc_queue_stats_by_ecc_agent]</td>
</tr>
<tr>
<td>Performance Analytics</td>
<td>Job Log [pa_job_logs]</td>
</tr>
<tr>
<td>Record Watcher</td>
<td>Responders [sys_rw_action], Channel Responders [sys_rw_amb_action]</td>
</tr>
<tr>
<td>Reporting</td>
<td>Summary Set [sys_report_summary], Report Summary Line [sys_report_summary_line]</td>
</tr>
<tr>
<td>Scheduled Jobs</td>
<td>Schedule Item [sys_trigger], Broadcast Message [sys_broadcast_message], Broadcast Message Relationships [sys_broadcast_message_m2m], Progress Worker [sys_progress_worker], Progress Worker Domain [sys_progress_worker_domain]</td>
</tr>
<tr>
<td>SSO</td>
<td>SSO Properties [sso_properties], Digest Token Properties [digest_properties], SAML Update 1 Properties [saml2_update1_properties], SSO Federation [sso_federation]</td>
</tr>
<tr>
<td>System Cache</td>
<td>Cache Flush [sys_cache_flush], Cache Entry [sys_db_cache]</td>
</tr>
<tr>
<td>System Clone</td>
<td>ServiceNow Instance [instance], Clone Security Token [clone_token], Preserved Data [clone_preserved_data]</td>
</tr>
<tr>
<td>System Dictionary</td>
<td>Dictionary Entry Override [sys_dictionary_override]</td>
</tr>
<tr>
<td>System Events</td>
<td>Event Processor [sys_event_processor]</td>
</tr>
<tr>
<td>System Fields</td>
<td>Field Class [sys_glide_object]</td>
</tr>
<tr>
<td>System Performance</td>
<td>Component Status [sys_status], Cluster Message [sys_cluster_message], Node State [sys_cluster_state]</td>
</tr>
<tr>
<td>Table Category</td>
<td>Table Names</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Text Index</td>
<td>Ts Attachment [ts_attachment], Text Index Attribute Map [ts_attribute_map], Ts Chain [ts_chain], Chain Summary [ts_chain_summary], Text Index Column Attribute Map [ts_column_attribute_map], Text Index Configuration [ts_configuration], Text Index Configuration Attribute [ts_configuration_attribute], Ts Delete Doc [ts_deleted_doc], Ts Document [ts_document], Ts Field [ts_field], Text Search Groups [ts_group], Japanese User Token [ts_japanese_token_dictionary], Ts Phrase [ts_phrase], Global Searches [ts_query], Knowledge Searches [ts_query_kb], Text Search Stat [ts_search_stats], Text Search Summaries [ts_search_summary], Stop Word [ts_stop], Synonym Dictionary [ts_synonym_dictionary], Synonym Set [ts_synonym_set], Text Search Table [ts_table], Text Index Table Attribute Map [ts_table_attribute_map], Service Catalog Searches [sc_ts_query], Ts Word [ts_word], Ts Word Roots [ts_word_roots]</td>
</tr>
<tr>
<td>Update Sets</td>
<td>Update Set [sys_update_set], Update Version [sys_update_version], Customer Update [sys_update_xml], Update Set Log [sys_update_set_log]</td>
</tr>
<tr>
<td>Upgrades</td>
<td>System Upgrades [sys_upgrade_history], Upgrade Details [sys_upgrade_history_log], System Upgrade Metric [sys_upgrade_metric], Upgrade Blame Log [sys_upgrade_blame], Upgrade Manifest [sys_upgrade_manifest], Upgrade State [sys_upgrade_state]</td>
</tr>
<tr>
<td>Usage Analytics</td>
<td>Usage Data for Applications [ua_app_usage], UsageAnalytics Count Configurations [usageanalytics_count_cfg], Application Metadata [ua_app_metadata], UsageAnalytics Count for Tables [usageanalytics_count], Subscription [license_details], Role for Subscription [role_has_license]</td>
</tr>
<tr>
<td>Users</td>
<td>User Session [sys_user_session], User Token [sys_user_token], User Preference [sys_user_preference], Navigator History [sys_ui_navigator_history]</td>
</tr>
<tr>
<td>Workflow</td>
<td>Workflow Execution [wf_workflow_execution], Workflow History [wf_history], Workflow Executing Activity [wf_executing], Workflow Queued Command [wf_command], Workflow Context [wf_context], Workflow Transition History [wf_transition_history]</td>
</tr>
</tbody>
</table>
**Condition Evaluation**

The condition in a Wait for Condition action is evaluated only when the record in the **Record** field is updated. Conditions must be set to be met upon a change to a record rather than a relative time period. For conditions that depend on a specific duration, consider using **Wait for a duration flow logic**.

In this example, the wait condition is valid because it is when the **Record** field is updated and the state is **Closed**.
In this example, the wait condition is invalid because it is a time relative to the **Created** date. Actions that have a condition that relies on a time interval will not be met, so the action is never performed.
Invalid wait condition

Output

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
</table>
| State | The completion status of the action as a numeric value.  
  • 0 (success)  
  • 1 (error) | Choice |
Design considerations

Follow these design considerations when creating flows that wait for a condition.

Use record triggers instead of wait conditions to start flows

If you only want a flow to run when certain record conditions are met, create a flow with a record trigger instead of starting and pausing a flow. A waiting flow consumes more system resources than a flow trigger.

Cancel flows whose resume conditions can never occur

Prevent your flows from waiting indefinitely by specifying flow stop conditions with End flow logic. To free up system resources, you can also cancel any flow whose resume conditions can never be met. For example, cancel flows waiting for incident record updates where the related incident is closed.

Flow Designer stages

Communicate the current stage of a request or flow with an end user.

When configuring stages in Flow Designer, you can:

• Create any number of stages.
• Change stage labels and names.
• Set the estimated duration for a stage.
• Import a copy of a pre-defined stage set from the Stage Sets table. To learn more about stage sets, see Workflow stage sets. Any changes made to the copy do not affect the original stage set record.

While stages can be added to a flow with a scheduled trigger, the stages are never displayed to an end user because there is no associated record for the stage field. Only use stages in flows with record and Service Catalog triggers. Stages are not supported on subflows.

View the stages of a flow in the flow execution details.

Displaying stages in a stage field

A stage field is a field of type Workflow that displays the stages of a flow to a user. For example, the Service Catalog uses a Stage field to indicate progress of a request as it is processed by an associated flow or workflow.

Stage fields display:

• Stages from flows with record or Service Catalog triggers.
• Stages from the associated flow. If the associated flow calls another flow, stages set on the child flow do not display.
• Stages from flows that have started.
State icons in stage fields cannot be modified. Limit the number of stages and the length of each stage name to represent each stage in a stage field without causing text and icons to wrap onto multiple lines.

**Note:** Only add one stage field per table. If there is more than one stage field, the system only displays stages from the first stage field defined in the table dictionary entry.

### Stage field and trigger types

Associating a flow to a stage field depends on the flow trigger type.

<table>
<thead>
<tr>
<th>Flow trigger type</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| Record              | For a stage field to report stages on a record-based flow, a stage field must be present on the same table as the triggering record. When a flow has stages, Flow Designer communicates the status of each stage back to the triggering table and displays the current stage state as an icon. If more than one stage field exists on the table, only the first stage field defined in the table's dictionary definition is used.  

**Note:** Avoid creating stages for multiple flows that trigger from the same table. A stage field only displays the stages of the final flow to run. Add different conditions to each flow to ensure that the stages of one flow do not overwrite another flow. |
| Service Catalog     | If using the Service Catalog trigger, the flow must be associated with the Service Catalog item through the **Flow** field. Remove any workflows associated with the item by clearing the **Workflow** and **Execution Plan** fields. The **Stage** field displays the current stage state on any list view of the Requested Items [sc_req_item] table. |
Stage states

During flow execution, each stage can be in one of five states.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>This stage has not yet started.</td>
</tr>
<tr>
<td>In progress</td>
<td>This stage is executing.</td>
</tr>
<tr>
<td>Skipped</td>
<td>This stage was skipped and did not run. Typically, this state is reached when a conditional flow logic block is not executed.</td>
</tr>
<tr>
<td>Complete</td>
<td>This stage is complete.</td>
</tr>
<tr>
<td>Error</td>
<td>This stage has reached an error condition.</td>
</tr>
</tbody>
</table>

When designing a flow, you can manually set the flow to report an Error state. To set an Error state:

- The flow must have at least one stage defined.
- The Error can only be set within a stage. When an Error condition is reached, the current stage is set to Error.
- The Error can only be set within a conditional flow logic block.

While setting the Error state does not affect flow execution, it communicates to the user that the state of the current stage is Error. For example, if an approval is not approved within the required limit you may want to communicate an error to the user.

Each stage can have its own custom state labels. For example, suppose that you have a flow with two stages. Stage 1 could have the Pending state with the label Waiting, and Stage 2 could have a Pending state with a label of Not yet started. Flow Designer provides options to generate either the default states or approval states.

Design considerations

Follow these design considerations when creating flows with stages.

Avoid defining stages that depend upon changes within a For Each flow logic block

Flow Designer prevents you from adding stages within a For Each block. You can only add stages before or after a For Each block.

Avoid having multiple flows with stages on the same table

A stage field always displays the stage information provided by the last flow to run on a table or record. If multiple flows run on the same records, then the stages defined in one flow can in theory overwrite the stages from another flow. To avoid multiple flows overwriting each other's stages, define unique trigger conditions for each flow.

Ensure multiple flows on the same table have unique trigger conditions

Adding unique trigger conditions to each flow ensures the flows only run under those conditions and prevents the stages from one flow overwriting the stages of another flow. Specifying unique trigger conditions makes it easier to troubleshoot flows by limiting the number of flow executions that can produce record changes.

Use error stages to communicate with the user
The flow error state does not affect flow execution. A flow will continue running even if it reaches an error stage. Use a conditional flow logic block to set the error stage and communicate to the user that the state of the current stage is Error. For example, if an approval is not approved within the required limit, you may want to communicate an error to the user.

**Use the error stage to stop processing a flow**

Use a conditional flow logic block to identify when the stage is error and stop processing the flow or take some kind of remediation action. For example, you may want to change a record state or assignment when a flow reaches an error state.

**Configure stages and add them to a flow**

Configure when stages display to a user, define stage state labels, and add stages to a flow within Flow Designer.

While stages can be added to a flow with a scheduled trigger, the stages are never displayed to an end user because there is no associated record for the stage field. Only use stages in flows with record and Service Catalog triggers.

**Role required:** flow_designer or admin

1. Optional: If not already present, create a stage field on the table that triggers the flow. A stage field is a field of type Workflow that displays the stages of a flow to a user. The Service Catalog Requested Items [sc_req_item] table has a stage field by default.

   For a stage field to report stages on a record-based flow, a stage field must be present on the same table as the triggering record.

   To add a field to a table, see Add and customize a field in a table.

2. Optional: If adding stages to a flow with a Service Catalog trigger, select the flow in the **Flow** field of the Service Catalog Item [sc_cat_item] table.

   If using the Service Catalog trigger, the flow must be associated with the Service Catalog item through the **Flow** field. Remove any workflows associated with the item by clearing the **Workflow** and **Execution Plan** fields. This enables a request for a catalog item to initiate a flow specific to that catalog item.

3. Open the flow in Flow Designer.

4. Optional: Create and configure stages in the More Actions menu. Alternatively, you can create stages within the flow itself.

   a) Click ![More Actions](image) and select **Stages**.

   The Flow Stages / State menu opens.

   b) Click **New Stage** to add a new stage and configure the stage options.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name for the stage. Must be unique.</td>
</tr>
<tr>
<td>Value</td>
<td>Internal name for the stage. Must be unique.</td>
</tr>
<tr>
<td>Duration</td>
<td>Estimated duration displayed to the user.</td>
</tr>
<tr>
<td>Always Show</td>
<td>If selected, the stage always displays in the stage field, even if the stage is set within a flow logic block that might not execute.</td>
</tr>
</tbody>
</table>

   c) Optional: Select a stage set to import from the Stage Sets table.

   To learn more about stage sets, see Workflow stage sets. Any changes made to the copy do not affect the original stage set record.
5. Point to a location in the flow and click **Add a Stage**. Select a stage or click + to add a new stage inline.

Stages can be applied at the beginning of any Flow Designer action or flow logic block, or within an If block. Stages are not supported within a For Each flow logic block.

**TRIGGER**

[Service Catalog]

**ACTIONS**

1. **Get Catalog Variables from Apple iPhone 6s**

**Note:** The stage field displays stages in the order they are defined in the flow.

**Important:** Stages are unavailable from within a **For Each** flow logic block. You can only add stages before and after a **For Each** flow logic block.
6. Optional: Set a stage to the Error state within a conditional flow logic block.
   a) Point to a location and select **Set "Error" State**.

   To set a stage to the Error stage:
   - The flow must have at least one stage defined.
   - The Error can only be set within a stage. When an Error condition is reached, the current stage is set to Error.
   - The Error can only be set within a conditional flow logic block.

   ![Flow Diagram](image)

   When the flow reaches the indicated point, the currently executing stage is set to Error in the stage field.

   In a flow with a record-based trigger, Flow Designer communicates the status of each stage back to the triggering table and displays the current stage state as an icon. In a flow with a Service Catalog trigger, the **Stage** field displays the current stage state on any list view of the Requested Items [sc_req_item] table.

**Flow execution details**

View runtime information about an action or flow directly from the design environment such as the current state, actions or steps run, and values produced. Open related records from embedded Now Platform editors or in a new tab.

Each time a flow or action runs, the system stores information about the configuration and runtime values produced, which process analysts can view from the Flow Designer design environment **Flow Executions** tab. Select a flow execution to open its associated execution details page.

**Note:** To avoid performance issues, turn off reporting during production with the `com.snc.process_flow.reporting.level` system property. For more information, see Flow Designer system properties.
Sample execution details of the VTB Sample Flow

Each execution details page displays:
• Calling source
• Flow state
• Related record options
• Flow Statistics

Calling source

The calling source lists what started a flow or subflow.

<table>
<thead>
<tr>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow Designer Test</td>
<td>The flow started because a user selected the <strong>Test</strong> option from the Flow Designer interface. The flow trigger conditions were ignored.</td>
</tr>
<tr>
<td>CRUD Trigger</td>
<td>The flow started when the record-based trigger conditions were met.</td>
</tr>
<tr>
<td>Scheduled Trigger</td>
<td>The flow started when the schedule-based trigger conditions were met.</td>
</tr>
<tr>
<td>Metric Trigger</td>
<td>The flow started when the MetricBase trigger conditions of a <strong>MetricBase</strong> were met.</td>
</tr>
<tr>
<td>Service Catalog Trigger</td>
<td>The flow started when a Service Catalog item was requested.</td>
</tr>
<tr>
<td>Script</td>
<td>The flow started from an API method call in a script, such as a business rule.</td>
</tr>
<tr>
<td>Background Script</td>
<td>The flow started from an API method call in the <strong>Scripts - Background</strong> module.</td>
</tr>
</tbody>
</table>

Flow state

All active flows are in one of these states.

Completed

The flow successfully ran all actions. The flow statistics display configuration and run-time details for each action.

Waiting

The flow paused on an action that is waiting for some condition to be met before continuing. The flow statistics display configuration and run-time details for completed actions and configuration details for any actions waiting for a condition to be met. Flows in the Waiting state display a **Cancel Flow** UI action in the header.

Error

The flow stopped with an error. The flow statistics display configuration and run-time details for completed actions and configuration details for the action that produced the error. Flows in the Error state display a **Go to error** UI action in the header.

**Note:** When an action results in an error, the flow stops executing at that point and results in an error state.
Related record options

From the Execution details page, you can access records related to the current flow.

**Refresh Flow Data**

Use this option to update flow runtime data.

**Open Flow**

Use this option to make configuration changes and publish a new instance of the flow. Changing the flow configuration does not change any currently active flow.

**Open Context Record**

Use this option to view the flow state, run duration, and related log entries from a standard form view. This option opens the context record in a new tab.

**Open Flow Logs**

Use this link to view detailed log information about each action. This link opens the log entries list in a new tab.

**Open Current Record**

For flows that have a record-based trigger, use this link to view the triggering record in a pop-up window.

**Open Action**

Use this link to make configuration changes and publish a new instance of the action. Changing the action configuration does not change any currently active flow. This link is unavailable for ServiceNow-provided core actions.

Flow statistics

Use flow statistics to see configuration details and run-time values for each flow component. Clicking a trigger or action expands the row and displays configuration and run-time details about it.
The following types of execution details are available.

**Integration Metadata**

Use Integration Metadata to view transaction data such as connection and credential used, target host, and payload size. Integration Metadata only displays for integration steps and requires a separate IntegrationHub subscription. For more information, see Integration steps.

**Configuration Details**

Use the list of input variables to identify any configuration errors with the action. Each variable has its own row displaying its name, data type, configuration settings, and run-time value. The configuration settings display dynamic values as pills. The run-time values display generated records as a link.

**Output Data**

Use the list of output variables to identify any configuration errors with the action.

**Logs**

Use the log entries to identify potential processing or performance issues. Each log entry has its own row displaying the creation date, log level, and log message. If the action does not generate any logs, the statistics displays the string *No Logs*.

**Steps**

Use the list of steps to identify any configuration errors with the action. Each step has its own row displaying the variable name, data type, configuration settings, and run-time value. Core actions do not display steps because users cannot change their configuration.

Change the `com.snc.process_flow.reporting.serialized.val_size_limit` system property to truncate runtime values in the flow execution details step configuration. To learn more, see Flow Designer system properties.

**Run duration**

Use the run duration to identify potential processing or performance issues. Each action and step displays the duration in milliseconds. System quota rules prevent any action from running longer than a minute.

**Embedded text viewer**

Flow Designer displays large text-based configuration and runtime output records such as email output, XML payloads, or script steps using an embedded text viewer. The embedded text viewer can format text as HTML, plain text, or color-coded JavaScript. For script steps, the text viewer highlights code lines containing errors.
function execute(inputs, outputs) {
    var vtblane = new GlideRecord('vtb_lane');
    vtblane.addQuery('board', inputs.vtbBoard.sys_id);
    vtblane.query();
    vtblane.next();

    var vtbcard = new GlideRecord('vtb_card');
    vtbcard.task = inputs.task.sys_id;
    vtbcard.board = inputs.vtbBoard.sys_id;
    vtbcard.lane = vtblane.sys_id;
    vtbcard.insert();

    outputs.vtbCard = vtbcard;
}(inputs, outputs);
Viewing results for each item in flow logic

Flow Designer displays a selector control to view the configuration and run-time results for each item processed by flow logic. Select a record number to see its configuration and run-time details.
Flow execution details retention

Due to the large amount of data used for flow designer reporting, your instance uses data retention policies to delete this data after a set time period.

Scheduled table cleanup

The time period used for scheduled table cleanup depends on the type of data stored. Once a record is older than its default retention period, it is deleted if it is in a completed state and the default skip_schedule_cleanup value is false.

Flow reporting data tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Default retention period</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_flow_action_report</td>
<td>Flow engine context action reports</td>
<td>6 Months</td>
</tr>
<tr>
<td>sys_flow_context</td>
<td>Flow context</td>
<td>6 Months</td>
</tr>
<tr>
<td>sys_flow_flow_report</td>
<td>Flow designer executions</td>
<td>6 Months</td>
</tr>
<tr>
<td>sys_flow_step_report</td>
<td>Flow engine context step reports</td>
<td>1 Week</td>
</tr>
</tbody>
</table>

Disable scheduled cleanup

The scheduled data cleanup for a flow can be disabled by setting the Skip Schedule Cleanup [skip_schedule_cleanup] field to true on the Flow engine contexts [sys_flow_context] record for the flow.

Change scheduled cleanup times

The retention periods shown in the preceding tables can be changed from their defaults by updating the Age in seconds field on the Auto Flushes [sys_auto_flush] table.

Disable reporting on a flow

Disable reporting on a flow by creating a record on the Settings [sys_flow_execution_setting] table for the flow, and setting the Reporting field to false. Navigate to Flow Designer > Settings to access this table. Create a record, and select a flow, subflow, or action. Enable or disable reporting using the Reporting field.

**Note:** Each record on the Settings table controls reporting for a single flow, subflow, or action. A setting record cannot have a value in both the Action and Flow fields.

**Note:** Setting records do not effect actions and subflows running within a parent flow. These settings are only honored when an action or subflow is run using the action API or script API. Setting records are honored for subflows executed with the Test button.

Reporting can be disabled for all flows using a system property. To disable the flow execution details, add the com.snc.process_flow.reporting.enabled system property to the System Properties [sys_properties] table and set the value to false. If disabled, details are not saved for actions in the flow. However, the flow context record and related log messages are available. If a flow runs while the property is false, execution
details are never available for the flow, even if the property value changes. If a flow runs while the property is true, execution details are always available for the flow, even if the property value changes.

Settings [sys_flow_execution_setting] records override this system property. For example, set the property to false in your production instance to disable all reporting, and use setting records to enable reporting specific flows. Limiting reporting in this way can increase performance of flow execution on your instance.

**Unavailable flow data**

A message displays at the top of the flow report to indicate that action reports are not available for a flow because of table cleanup. The **Show Action Details** link and Action states are not available in this case. A similar message is shown to indicate when reporting for a flow has been disabled. In this case, a link to the report settings also displays.
Flow logic

Enable flows and subflows to specify conditional or repeated actions. Combine the elements of flow logic to create workflows in a graphical interface with little or no scripting.
The system provides these flow logic options.

<table>
<thead>
<tr>
<th>Flow logic option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Workflow</td>
<td>Run a published and active workflow from your flow. You can use the flow data as a workflow input. For example, you can specify the current record as a workflow input.</td>
</tr>
<tr>
<td>Do the following in parallel</td>
<td>You can separate a flow into blocks of actions and subflows that run in parallel, reducing the time taken to execute a flow.</td>
</tr>
<tr>
<td>Do the following until</td>
<td>Apply one or more actions repeatedly until an end condition is met. You can use the flow data to specify the end conditions.</td>
</tr>
<tr>
<td>End</td>
<td>Use this flow logic to stop a flow within flow designer.</td>
</tr>
<tr>
<td>For each</td>
<td>Apply one or more actions to each record in a list of records.</td>
</tr>
<tr>
<td>If</td>
<td>Selectively apply one or more actions only when a list of conditions is met.</td>
</tr>
<tr>
<td>Make a decision</td>
<td>You can use the decision table branching logic in situations where multiple conditional paths are required, as an alternative to nested If, Else If, or Else flow logic. For example, if you want to determine what kind of car insurance you need, you can add inputs such as your age accident history, and car model to the decision table to determine a level of insurance coverage. This logic can save you time and present a more readable format than nested if conditions or switch case statements.</td>
</tr>
<tr>
<td>Wait for a duration of time</td>
<td>Use this flow logic to give your users time to act during automated processes or to wait for a specific date and time to complete actions</td>
</tr>
</tbody>
</table>

**Flow logic inputs**

Each flow logic option displays one or more fields that are used to determine its behavior. For example, the Call Workflow flow logic has an input where you are able to select a workflow to run. Use these inputs to define the behavior of the flow and enable optional functionality depending on your needs. See flow logic option documentation for a list of the available inputs and how they control the function of that element.

**Flow logic outputs**

Flow logic options may also have outputs. These represent information that is returned by the flow logic. For example, the Make a decision flow logic has an output that contains a decision answer record representing the decision reached by the flow. See the documentation for a flow logic option to see definitions for its outputs.

**Call a workflow flow logic**

Run a published and active workflow from your flow. You can use the flow data as a workflow input. For example, you can specify the current record as a workflow input.
### Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a Workflow</td>
<td>Published and active workflow that you can select to run. The workflow that you select determines the records that are associated with it. If the workflow has inputs, Flow Designer displays them as additional flow inputs.</td>
</tr>
<tr>
<td><strong>Note</strong>:</td>
<td>To prevent the workflow from running outside of Flow Designer, modify it to remove its start conditions.</td>
</tr>
<tr>
<td>Wait?</td>
<td>Workflow that you set to true so that the flow waits for workflow completion before continuing. Only workflows that wait for completion can return certain output values to the flow. Set to false to continue running the flow separately from the workflow.</td>
</tr>
<tr>
<td><strong>Note</strong>:</td>
<td>If the workflow is canceled or its context record is deleted prior to the workflow finishing, the flow stops waiting and instead continues running.</td>
</tr>
<tr>
<td>Current</td>
<td>Current record that the workflow processes. Select a data pill that contains a record from the associated workflow table.</td>
</tr>
</tbody>
</table>

### Outputs

The flow execution details only display workflow output values that are generated while the flow is running. If you configure the flow to wait for the workflow to finish, the flow execution details can display all workflow output values. If the flow does not wait, the flow execution details only display the workflow output values that were generated before the Call a Workflow flow logic completes. If Call a Workflow completes before the workflow finishes, the workflow output values stop updating and only display the last known value.

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>State of the workflow. This value comes from the workflow context record. The state will be Complete if the workflow executes successfully. If the workflow is canceled, the workflow state is set to Canceled. If the context record is deleted prior to the workflow finishing, the workflow state is set to Invalid.</td>
</tr>
<tr>
<td>Context</td>
<td>Reference to the workflow context record.</td>
</tr>
<tr>
<td>Result</td>
<td>String that contains the result from the workflow. This value comes from the workflow context record.</td>
</tr>
</tbody>
</table>
### Output

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\textbf{Return value}</td>
</tr>
</tbody>
</table>

String that contains the return_value from the workflow. This value comes from the workflow context record.

### Calling the Routine Change workflow

In this example, the flow calls the **Routine Change** workflow. The **Wait?** option is checked, so the flow pauses until this workflow completes. The **Current** field is filled using a data pill representing the record that triggered this flow.

**Actions**

1. **Call a Workflow**

   
   Select a Workflow: Routine Change
   
   - **Wait?:** ✓
   
   - **Current:** Trigger→Incident Record→Change Request
# Execution details

<table>
<thead>
<tr>
<th>Action Details</th>
<th>State</th>
<th>Start time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call a Workflow</td>
<td>Completed</td>
<td>2018-06-13 13:38:48, 1488ms</td>
</tr>
</tbody>
</table>

## Workflow Configuration

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>TYPE</th>
<th>Configuration</th>
<th>Runtime Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>wait</td>
<td>True/False</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>current</td>
<td>Document ID</td>
<td>Trigger=Knowledge Record</td>
<td>Knowledge - Instant Publish</td>
</tr>
<tr>
<td>Workflow</td>
<td>Document ID</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Workflow Output

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>TYPE</th>
<th>Configuration</th>
<th>Runtime Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Result</td>
<td>String</td>
<td></td>
<td>finished</td>
</tr>
<tr>
<td>Return Value</td>
<td>String</td>
<td></td>
<td>Knowledge - Instant Publish</td>
</tr>
<tr>
<td>State</td>
<td>String</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Workflow Context Record</td>
<td>Reference</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Call Workflow execution details

1. The header displays a link so that you can view the workflow progress in the Workflow Editor, the flow logic state, the start time, and the runtime duration.
2. The **Workflow Configuration** section displays how the flow logic was configured for this flow and the runtime values that were generated.
3. The **Workflow Output** section displays the output that is generated by the workflow while the flow is running.

**Note:** If you cancel the workflow or delete the context record prior to the workflow finishing, the flow logic state is set to **Complete**.

## Do the following in parallel flow logic

You can separate a flow into blocks of actions and subflows that run in parallel, reducing the time taken to execute a flow.

With this flow logic you can divide your flow into branches that contain their own actions and subflows. Each of these branches runs in parallel when the flow executes, allowing you to save time and avoid waiting for each action to complete one at a time.
Inputs

Each flow logic option added to your flow will display one or more inputs. Use these inputs to determine the behavior of the flow logic.

Branches in do the following flog logic inputs

**Do the following in parallel** flow logic does not have field inputs. Instead, it displays a plus icon that enables you to create a branch that contains actions or subflows.

The actions and subflows under each branch run in parallel. The flow continues after all parallel branches have completed.

Outputs

This flow logic has no outputs, but actions and subflows under each branch may have outputs. While the flow is running, outputs from a branch are only accessible to other elements in the same branch. After the **Do the following in parallel** flow logic completes, its outputs are accessible to the rest of the flow.

**Create two tasks in parallel when a change request is created**

In this example, a flow triggers when a new change request is created. Using **Do the following in Parallel**, two tasks are created in parallel and are assigned to different groups. The flow uses the **Number** field data pill from the triggering change request to display the number in the short description for the task.
Do the following in parallel flow logic inputs
Execution details

Do the following in parallel execution details

1. The header shows the state, start time, and runtime for the flow logic.
2. The Configuration Details section shows the state, start time, and runtime for each parallel branch.

Do the following until flow logic

Apply one or more actions repeatedly until an end condition is met. You can use the flow data to specify the end conditions.

You can use Do the following until flow logic to create a loop that repeatedly applies actions. This flow logic requires a condition specifying when to stop the loop.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition label</td>
<td>Descriptive label for the loop.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions under which the loop terminates. You could, for example, end a loop when the state of an incident changes.</td>
</tr>
</tbody>
</table>

Note: Avoid using the same record you used to trigger the flow in your condition, because the flow populates its values when the flow starts and they remain static.
Send a daily email until an incident is resolved

In this example, the flow sends a daily email about the incident, until the incident is in a closed or canceled state. Inside the **Do the following** branch, there is a step for looking up the incident record. This is necessary because the record that triggers the flow is only loaded when it is triggered. By adding this look up step, you can get the current state of the incident each time the loop runs.
Outputs

This flow logic produces no outputs.

Execution details

Execution details for Do the following until

1. The header shows the state, start time, and runtime for the flow logic.
2. This flow logic can run actions or subflows multiple times until it's condition is met. Use the arrow icons to select an iteration and its values.
3. The Actions section shows details on the actions, flows, or subflows that are run during this loop iteration.

End flow logic

Use this flow logic to stop a flow within flow designer.

End flow logic can be contained within a conditional flow logic block, such as an If, Else If, or Else flow logic block. Use this flow logic to stop a flow when certain conditions are met. You cannot add actions or flow logic after you use the End flow logic. All branches of a flow are ended when a flow reaches the End flow logic, including the Wait for a duration logic. Any branches that run in parallel also stop their progress when you use the End flow logic.
Inputs

This flow logic has no inputs.

Execution Details

When a flow ends, the flow state becomes Complete.

For Each flow logic

Apply one or more actions to each record in a list of records.

The For Each flow logic requires a list of records to act upon. The flow applies all actions within the for each flow logic to each record in that list.

Note: Iterating over a large number of records can be resource intensive, especially when the For Each logic block includes complex actions for each iteration. To avoid performance issues, turn off reporting using the com.snc.process_flow.reporting.level system property. For more information, see Flow Designer system properties.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>Data pill that contains a list of records. For example, you could use the additional Assignee list for an incident record. For information on data pills, see Flow Designer data.</td>
</tr>
</tbody>
</table>

Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Table name] Record</td>
<td>Current record in the loop.</td>
</tr>
</tbody>
</table>

Note:

To optimize performance, avoid iterating over lists with more than one thousand records. If you need to iterate over large lists, divide the lists into smaller sections and use multiple flows.

You can nest a For Each flow logic block inside of another flow logic block to repeat an action over a series of records. However, avoid nested For Each loops that process many records. Nested loops may cause the flow to run until it is stopped by the flow transaction quota rule, which prevents flows from running longer than an hour. For more information about transaction quotas, see Transaction quotas.

Send an email to each person assigned to a problem

In this example, a flow is created to send an email to each additional assignee of a problem record when a record is created. If the For Each flow logic is selected, and the Additional Assignee data pill is dragged
in from the trigger record, the **For each** logic performs actions for each user in the **Additional Assignee** field of the trigger record.

When the loop is created, a new entry appears in the Data pane on the right called **1 - For Each**. In that entry, you see an **Additional assignee list Record** data pill that contains the user information for the users in that field.

**Inputs used in for each flow logic**

In this example, you configure a flow to send an email to each user in the **Additional Assignee** field on the triggering problem record. The plus icon below this email action is used to add additional actions, such as logging, to the loop.
The flow execution details tab provides runtime information on the flow logic.

1. The header shows the state, start time, and runtime for the flow logic.

2. This flow logic can run actions or subflows multiple times. Use the arrow keys to cycle through each of these instances to see their values.

3. The Configuration Details section shows which records the flow has evaluated.

4. After the For Each section are the actions taken within it. The values for these actions change as you cycle through the actions that are taken by this flow logic.

If flow logic

Selectively apply one or more actions only when a list of conditions is met.

Use this flow logic by specifying conditions that are based on the current record. Actions or subflows can be added to the flow within the if flow logic. The flow only applies the actions within this flow logic if the conditions evaluate to true. Conditions are based on data in records, such as a records state or urgency.
Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition label</td>
<td>Descriptive label for the branch.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions under which the branch runs.</td>
</tr>
</tbody>
</table>

Perform an action on if an incident has a high urgency

In this example, the action is triggered when the incident record has a high urgency value.

```
1. If Urgent then

Condition Label: Urgent

Condition 1: Trigger Incident Record Urgency is 1 - High

Add another condition set (OR)
```
Execution details

1. The header shows the state, start time, and runtime for the flow logic.
2. The Configuration Details section shows the details about the variables that are used by the flow, including the type, configuration, and runtime values for each variable. Use the condition variable to see if the branch conditions were met.

Make a decision flow logic

You can use the decision table branching logic in situations where multiple conditional paths are required, as an alternative to nested If, Else If, or Else flow logic. For example, if you want to determine what kind of car insurance you need, you can add inputs such as your age accident history, and car model to the decision table to determine a level of insurance coverage. This logic can save you time and present a more readable format than nested if conditions or switch case statements.

The Make a decision flow logic requires that you create an external decision table for its branch paths. Each answer that is defined in the decision table results in a branch path within Flow Designer. Decision tables accept any number of inputs, include any number of decisions, and result in a finite set of decision paths. You can configure a decision table to determine a single path or multiple paths. For more information on decision tables, see Decision Tables.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decision Label</td>
<td>Descriptive label for the decision that you want to make. For example, you can create the Recommended Insurance Policy label if you want to determine the level of insurance coverage that you need. This value overrides the default action label.</td>
</tr>
</tbody>
</table>
## Input

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decision table</td>
<td>Reference to a Decision Table [sys_decision] record. This record provides the decision input answers that are available to the flow.</td>
</tr>
<tr>
<td>Execution approach</td>
<td>Approach that you select to execute your decision.</td>
</tr>
<tr>
<td></td>
<td>• <strong>First decision that matches</strong>: Runs only the branch for the first matching decision answer.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Run all decisions that match</strong>: Runs all branches with a matching decision answer.</td>
</tr>
<tr>
<td>Include otherwise</td>
<td>Option to add the <strong>otherwise</strong> branch. The flow only runs this branch when no other branch runs.</td>
</tr>
<tr>
<td>Decision table inputs</td>
<td>List of Decision Input [sys_decision_input] records that are associated with your decision table. Flow Designer displays a separate input for each record. For example, if you have decision inputs for <strong>Units Ordered</strong> and <strong>Location of Sale</strong>, an input displays for each record.</td>
</tr>
</tbody>
</table>

## Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decision answer record</td>
<td>Record that was created after the decision inputs were evaluated.</td>
</tr>
</tbody>
</table>

## Use make a decision flow logic to determine insurance coverage

In this example, the flow uses a decision from the **Insurance Coverage** decision table, which an administrator had configured to determine the insurance coverage that was based on three inputs. The flow displays all the inputs that were used by the decision table in Flow Designer. These inputs can be entered manually, or by dragging data pills into the inputs from the Data pane on the right side of the screen. Below this section, the branches for each answer are shown in the decision table.
TRIGGER

Incident Updated

ACTIONS

1

Decision Label: Decide Coverage Level

Decision Table: Decide Coverage Level

Execution: First decision that matches

Include Otherwise: 

1.1

Bronze

1.2

Gold

1.3

Silver

Click to add an Action, Flow Logic, or Subflow
### Execution details

<table>
<thead>
<tr>
<th>Hide Action Details</th>
<th>State</th>
<th>Start time</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FLOW STATISTICS</strong></td>
<td>Completed</td>
<td>2018-10-03 14:42:43</td>
<td>1657ms</td>
</tr>
<tr>
<td><strong>TRIGGER</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Incident Updated</td>
<td>Open Current Record</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### ACTIONS

1. **Decide Coverage Level**

<table>
<thead>
<tr>
<th>Decision Table Configuration</th>
<th>Type</th>
<th>Configuration</th>
<th>Runtime Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>decision_table</td>
<td>Reference</td>
<td>7f8b78f83d3b3b36a030e6c65403ce9615e6</td>
<td></td>
</tr>
<tr>
<td>execution</td>
<td>Choice</td>
<td>first_match</td>
<td>first_match</td>
</tr>
<tr>
<td>answer_table</td>
<td>Table Name</td>
<td>decision_answer</td>
<td>false</td>
</tr>
<tr>
<td>include OTHERWISE</td>
<td>True/False</td>
<td>false</td>
<td>false</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Decision Table Input</th>
<th>Type</th>
<th>Configuration</th>
<th>Runtime Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accidents in last 5 years</td>
<td>True/False</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>Car Model Year</td>
<td>Integer</td>
<td>2017</td>
<td>2017</td>
</tr>
<tr>
<td>Driver Age</td>
<td>Integer</td>
<td>40</td>
<td>40</td>
</tr>
</tbody>
</table>

#### Decision Table Output

<table>
<thead>
<tr>
<th>VARIABLE NAME</th>
<th>Type</th>
<th>Configuration</th>
<th>Runtime Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>answer</td>
<td>Document ID</td>
<td>8bc34d3db30a300ef0d5f40ce9615d2</td>
<td></td>
</tr>
</tbody>
</table>

#### Configuration Details

<table>
<thead>
<tr>
<th>VARIABLE NAME</th>
<th>Type</th>
<th>Configuration</th>
<th>Runtime Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Document ID</td>
<td>Trigger=Incident_Record</td>
<td>INC00000059</td>
</tr>
<tr>
<td>Table</td>
<td>Table Name</td>
<td>incident</td>
<td>incident</td>
</tr>
<tr>
<td>Fields</td>
<td>Template Value</td>
<td>work_notes=Recommend Gold Coverage</td>
<td>work_notes=Recommend Gold Coverage</td>
</tr>
</tbody>
</table>

#### Output Data

<table>
<thead>
<tr>
<th>VARIABLE NAME</th>
<th>Type</th>
<th>Configuration</th>
<th>Runtime Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Document ID</td>
<td>Update Record step = Record</td>
<td>INC00000059</td>
</tr>
<tr>
<td>table_name</td>
<td>Table Name</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### 1.1 **Update Record**

<table>
<thead>
<tr>
<th>Core Action</th>
<th>State</th>
<th>Start time</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed</td>
<td></td>
<td>2018-10-03 14:42:43</td>
<td>1546ms</td>
</tr>
</tbody>
</table>

1.2 **Bronze Coverage**

<table>
<thead>
<tr>
<th>Core Action</th>
<th>State</th>
<th>Start time</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Run</td>
<td></td>
<td>2018-10-03 14:42:43</td>
<td>0ms</td>
</tr>
</tbody>
</table>

1.3 **Silver Coverage**

<table>
<thead>
<tr>
<th>Core Action</th>
<th>State</th>
<th>Start time</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Run</td>
<td></td>
<td>2018-10-03 14:42:43</td>
<td>1ms</td>
</tr>
</tbody>
</table>
The **Flow execution details** tab provides runtime information about the flow logic.

1. The header shows the state, start time, and runtime for the flow logic.
2. The action shows details about the decision table configuration and inputs.
3. Each possible answer for the decision table is represented as a branch. The state field indicates whether the branch was evaluated and the evaluation result. This section also displays details about the actions that are taken within a branch. Branches that evaluate to true are highlighted in green.

### Wait for a duration flow logic

Use this flow logic to give your users time to act during automated processes or to wait for a specific date and time to complete actions.

#### Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Duration Type</strong></td>
<td>• <strong>Explicit Duration</strong>: Wait for a specific time period, such as 5 minutes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Relative Duration</strong>: Wait for a specific time period from a selected Duration data pill or date/time value, such as 5 minutes after the flow start.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Percentage Duration</strong>: Type to specify a certain percentage of time duration between the start of the flow logic and specified end time.</td>
</tr>
</tbody>
</table>

*Note:* The percentage value must be from 0 through 100 only.

<table>
<thead>
<tr>
<th>Wait for</th>
<th>Set this value manually or select a Duration data pill from the data pill picker ( ).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Explicit Duration</strong>: Wait duration in hours, minutes, and seconds.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Relative Duration</strong>: Wait duration in hours, minutes, and seconds before or after a specific time. Select <strong>Relative Duration</strong> to specify a wait duration from a specific date.</td>
</tr>
</tbody>
</table>

*Note:* Past dates don’t affect the wait duration.

You can enter a wait value of up to 999 hours.

*Note:* The actual wait duration can vary due to the instance processing time. The flow always waits for the time that you specify for this field, but other work in the queue may add to the wait time.
### Input

<table>
<thead>
<tr>
<th>Description</th>
<th>Wait for Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait duration as a percentage of the time period between the start of flow logic and specified end time. If you select a past date for the end time, the wait duration is set to 0. This field appears when <strong>Percentage Duration</strong> is selected from <strong>Duration Type</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
<th>During the following schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the schedule used to calculate the <strong>Scheduled End date/time</strong> value from the selected wait duration. For example, waiting for a 10-hour duration as part of an 8-5 weekdays schedule causes the flow to wait for one or more business days. If you leave this field blank, the timer runs without a schedule. For information on creating schedules, see <strong>Define a schedule</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

### Outputs

<table>
<thead>
<tr>
<th>Description</th>
<th>Total duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total time that the flow ran in milliseconds. You can drag this data pill into the duration fields.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
<th>End at time/date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/time that the flow completed. You can drag this data pill into the date/time fields.</td>
<td></td>
</tr>
</tbody>
</table>

**Close an incident if it has been in the resolved state for 10 days**

In this example, a flow starts when an incident changes to resolved.
Wait 10 days after the last update to a record

In this example, the flows waits for 10-days after the incident record has been resolved.
Update a record after 10 days

In this example, the flows closes the incident record 10 days after it was resolved.
Wait for a duration of 50% of the time between the start of the flow logic and end date

In this example, the flows send a notification email to the relevant manager when a critical problem is created and 50% of the time between the problem record creation and the problem due date has lapsed.
Relative Duration type

When the duration type is **Relative Duration**, the flow logic first evaluates the relative date/time, the schedule, and finally, the duration. Schedules and date/times set in the past do not affect the wait duration. This table provides examples of how the flow processes the wait duration in these scenarios.

<table>
<thead>
<tr>
<th>Duration Setting</th>
<th>Relative Date/Time</th>
<th>Schedule</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set to 0.</td>
<td>None</td>
<td>None</td>
<td>Duration ends immediately.</td>
</tr>
<tr>
<td>Greater than 0.</td>
<td>Past date</td>
<td>None</td>
<td>Duration ends immediately.</td>
</tr>
</tbody>
</table>
### Duration Setting

<table>
<thead>
<tr>
<th>Duration Setting</th>
<th>Relative Date/Time</th>
<th>Schedule</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Greater than 0.</td>
<td>Future date</td>
<td>None</td>
<td>Flow waits for the date/time, and then waits for the duration.</td>
</tr>
<tr>
<td>Greater than 0</td>
<td>Past date</td>
<td>Future date</td>
<td>Flow waits for schedule, and then waits for the duration.</td>
</tr>
<tr>
<td>Greater than 0.</td>
<td>Future date</td>
<td>Past date</td>
<td>Flow waits for the date/time, and then waits for the duration.</td>
</tr>
<tr>
<td>Greater than 0.</td>
<td>Future date</td>
<td>Future date</td>
<td>Flow waits for the future date, then for the schedule, and then for the duration.</td>
</tr>
</tbody>
</table>

The timer waits for the next instance of a selected schedule. For example, if you set a schedule for Monday through Friday from 8 a.m. to 5 p.m., and the timer is initiated on Saturday, the timer waits until Monday at 8 a.m. before starting.

### Execution details

```
1. Timer was scheduled to end on Tuesday, August 14, 2018, 13:50:26 PDT

Execution details for Wait for a duration flow logic
```
1. The header shows the state, start time, and runtime for the flow logic.

**Note:** The runtime value in the header only includes the time that is taken to execute the flow logic and does not include the wait duration that is specified in the flow.

2. The Configuration Details section shows details about the variables that are used by the flow, including the type, configuration, and runtime values for each variable.

**Subflows**

Define a sequence of reusable actions that can be started from a flow, subflow, or script. Define inputs and outputs to pass data to and from the subflow.

Unlike flows, subflows lack a trigger. Use a subflow when:

- You only want to start a flow by calling it from another flow or script.
- You want to create a set of reusable operations for use in multiple flows.
- You want to add flow logic in addition to actions.
- You want to specify the inputs available to the subflow when it starts.
- You want to specify the outputs available to the parent flow after the subflow ends.

All subflows consist of properties, one or more inputs, one or more outputs, a sequence of actions, and the data collected or created.

**Subflow properties**

The subflow properties specify the subflow name, application, category, description, in-flow annotation, and status. Flow designers can update the subflow name, category, description, and in-flow annotation at any time, but can only set the application during subflow creation. The subflow status is set when you save or publish a subflow.

**Subflow inputs**

Subflow inputs specify the data available to the subflow when it starts. Each input you define for a subflow becomes a configuration option in the Flow Designer interface. To use the subflow in a flow, flow designers must define a value for each mandatory input. The more inputs a subflow has, the more data flow designers must define and the more familiar they must be with the underlying data model to use the subflow effectively.

Inputs provide advanced options based on their data type. All inputs have advanced options to add a hint or provide a default value. Use advanced options to guide flow designers through adding and configuring a subflow to a flow. For example, create a choice input to provide flow designers with a pre-defined list of configuration options to choose from. For more information about the configuration options available to particular data types, see field types.

**Subflow outputs**

Subflow outputs specify the data available to the parent flow after the subflow completes. Subflow outputs are defined as variables with a name and data type. Subflow designers assign values to an output using the Assign Subflow Output flow logic. Output values can be based on the subflow logic conditions, action results, or a manually set value. For example, an output may have one value when a condition is met and
another value when a condition is not met. During runtime, the value of the output is determined by the condition that is met.

Consider the following example of a subflow with two conditions that both result in a value for a single output variable. The value of the variable depends on which condition is met during runtime.

**Outputs**

[Manager ID] [String]

**Actions**

- 1 Look Up [User] Record where (Created on Today)
- 2 If ([1->User Record->Title] contains Manager) then
  - 2.1 Assign Subflow Outputs [Manager ID] to [1->User Record->User ID]
- 3 Else
  - 3.1 Assign Subflow Outputs [Manager ID] to [1->User Record->Manager->User ID]

In this case, if the user's title contains "Manager" then the user ID is assigned as output. Otherwise, the subflow looks up the user's manager and assigns the user ID of the manager as output.

Flow Designer allows you to define a value for the same variable multiple times. However, if a variable is given two or more possible values without conditional logic, only the last value defined in the subflow is applied to the output at runtime.

**Outputs**

[Manager ID] [String]

**Actions**

- 1 Look Up [User] Record where (Created on Today)
- 2 Assign Subflow Outputs [Manager ID] to [1->User Record->User ID]
- 3 Assign Subflow Outputs [Manager ID] to [1->User Record->Manager->User ID]

In this example, action three overwrites the value of action two and [1->User Record->Manager->User ID] is applied to the [Manager ID] output at runtime because it was the last value defined. Typically, subflows should only include multiple values for one variable if conditional flow logic is used.

**Subflow execution details**

Access to subflow execution details depends upon the calling source of the subflow.

**When the calling source is a parent flow**

Flow Designer displays subflow execution details within the parent flow execution details. The parent flow execution details list each subflow as inline elements. You can expand a subflow step to see its execution details.

**When the calling source is a script**

Each script call to a subflow generates a separate flow execution detail page. You can view script-run subflow execution details directly from the list of flow executions.
Actions

Within Actions, flow designers can add actions, flow logic, flows, or other subflows.

An action is a reusable operation that enables process analysts to automate Now Platform features without having to write code. For example, the Create Record action allows process analysts to generate records in a particular table with particular values when certain conditions occur. Core actions like Create Record require some familiarity with Now Platform tables and fields. Action designers can create application-specific actions to pre-set configuration details. For example, creating a Create Incident Task action ensures that the process analyst uses the correct table and field configuration each time the action is used. You can add application-specific actions by activating the associated spoke.

Flow logic

Subflows can contain flow logic to specify conditional or repeated actions, or to assign output variables to subflow data. The system provides these flow logic options.

Available flow logic

<table>
<thead>
<tr>
<th>Flow logic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>For Each</td>
<td>Applies actions to each record in a list of records. Flow designers must specify the list of</td>
</tr>
<tr>
<td></td>
<td>records from the subflow data.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can nest a For Each flow logic block inside of another flow logic block to</td>
</tr>
<tr>
<td></td>
<td>repeat an action over a series of records. However, avoid nested For Each loops that process</td>
</tr>
<tr>
<td></td>
<td>many records. Nested loops may cause the flow to run until it is stopped by the flow</td>
</tr>
<tr>
<td></td>
<td>transaction quota rule, which prevents flows from running longer than an hour. For more</td>
</tr>
<tr>
<td></td>
<td>information about transaction quotas, see Transaction quotas.</td>
</tr>
<tr>
<td>If</td>
<td>Applies actions when a list of conditions is met. Flow designers can specify the conditions</td>
</tr>
<tr>
<td></td>
<td>as subflow data. Once an If condition is added, you can add an Else or Else If flow logic</td>
</tr>
<tr>
<td></td>
<td>options to define behavior when conditions are not met.</td>
</tr>
<tr>
<td>Assign Subflow Outputs</td>
<td>Assigns an output variable to subflow data. Only outputs defined in Inputs &amp; Outputs can be</td>
</tr>
<tr>
<td></td>
<td>assigned a value. Assigning outputs enables you to assign a different output variable for each</td>
</tr>
<tr>
<td></td>
<td>logical path in the subflow.</td>
</tr>
</tbody>
</table>

Testing subflows

You can test a subflow alone, or when added to a flow. When testing a subflow alone, you must define the inputs that the subflow uses in its actions. Because a subflow does not have a trigger, testing a subflow runs the actions using the defined input values.

**Note:** Flow designers should always test flows and subflows on sub-production instances containing relevant demonstration data since testing a subflow creates or changes records on the instance.

Roles

To access subflows, a user must have the flow_designer or admin role.
Create a subflow

Create a reusable sequence of actions that can be added to multiple flows.

- Role required: flow_designer or admin
- Set up an application in Guided Application Creator to store Flow Designer content.

Users with flow_designer or admin role should know the application table structure and be aware of any existing business logic associated with the target tables of a flow or subflow. Be sure to disable any conflicting business rules or workflows before creating a flow or subflow.

Creating a custom application to contain your Flow Designer content allows you to deploy it using the application repository or the ServiceNow Store.

1. Navigate to Flow Designer > Designer.
2. Click + New > New Subflow.
   The Subflow properties dialog displays.
3. Fill in the following properties:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the subflow.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope to create the subflow in.</td>
</tr>
<tr>
<td>Category</td>
<td>Logical group for subflow.</td>
</tr>
<tr>
<td>Protection</td>
<td>Select whether the subflow is read-only. You can only select a value when you create the subflow in an application scope you own. The default value is None.</td>
</tr>
<tr>
<td>In-Flow Annotation</td>
<td>Help text that appears under the subflow title in Flow Designer to help flow designers understand what the subflow does when used in a flow.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the subflow.</td>
</tr>
<tr>
<td>Run As</td>
<td>Selection to specify if the flow runs as system user or the user who initiates the session. Select the user who initiates the session option when updates should come from the user who triggered the flow. For example, when you want incident record comments to come from the current user, or approval emails to originate from the approver. Run As settings for a flow do not apply to child subflows. Running as the initiating user also ensures the actions taken during flow execution are limited by the user's ACL restrictions. Flows run by the initiating user will also respect user-specific settings like date/time format.</td>
</tr>
</tbody>
</table>

4. Create subflow inputs to specify the data available to the subflow when it starts.
   Each input you define for a subflow becomes a configuration option in the Flow Designer interface.
   To use the subflow in a flow, flow designers must define a value for each mandatory input. The more
inputs a subflow has, the more data flow designers must define and the more familiar they must be with the underlying data model to use the subflow effectively.

a) Click + to open the Inputs & Outputs pane.

b) Click + to add a new input.

c) Define the name and type for the input.

<table>
<thead>
<tr>
<th>Note: Subflow input names can't include any of the following reserved system names:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• sys_id</td>
</tr>
<tr>
<td>• sys_created_by</td>
</tr>
<tr>
<td>• sys_created_on</td>
</tr>
<tr>
<td>• sys_updated_on</td>
</tr>
<tr>
<td>• sys_updated_by</td>
</tr>
<tr>
<td>• sys_mod_count</td>
</tr>
</tbody>
</table>

d) To make the input a mandatory configuration option, select the Mandatory flag.

e) Click to view the advanced options and define values.

Inputs provide advanced options based on their data type. All inputs have advanced options to add a hint or provide a default value. Use advanced options to guide flow designers through adding and configuring a subflow to a flow. For example, create a choice input to provide flow designers with a pre-defined list of configuration options to choose from. For more information about the configuration options available to particular data types, see field types.

5. Create subflow outputs by defining the names and data types.

Subflow outputs specify the data available to the parent flow after the subflow completes.

a) Click + to add a new output.

b) Define the name and the data type.

Output values are assigned in later steps.

<table>
<thead>
<tr>
<th>Note: Subflow output names can't include any of the following reserved system names:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• sys_id</td>
</tr>
<tr>
<td>• sys_created_by</td>
</tr>
<tr>
<td>• sys_created_on</td>
</tr>
<tr>
<td>• sys_updated_on</td>
</tr>
<tr>
<td>• sys_updated_by</td>
</tr>
</tbody>
</table>
6. To add actions, flows, subflows, or flow logic, click **Select to add an Action, Flow Logic, or Subflow**. 
   a) Select an option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Action** | Select the desired action. Flow Designer includes a set of Actions available to flows and subflows. Alternatively, user with the action_designer role can create additional actions to add to flows. The IntegrationHub and spoke plugins install additional actions.  
To add draft actions from the More Actions menu, set **Show draft actions** to true.  
To view spokes available in the ServiceNow Store, set **Show store spokes** to true from the More Actions menu.  
Note: Under **Not Installed Spokes**, the system displays spokes available on the ServiceNow Store based on compatibility with the ServiceNow version and application dependency on Flow Designer. |
<p>| <strong>Flow Logic</strong> | Select an option to specify conditional or repeated operations. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subflow</td>
<td>Select a published subflow and define input values. In addition to adding a subflow as a flow action, you can enable the <strong>Show triggered flows</strong> option from the More Actions menu to select an activated flow and define the required inputs. Running a triggered flow ignores its trigger conditions and runs all actions.</td>
</tr>
</tbody>
</table>

To change the order of an action in a flow, drag the handle on the left side of the action to the desired location.

The system displays a set of fields depending on the option selected.

b) To configure the action, flow, or subflow, fill in the fields.

c) Click **Done**.

d) Repeat adding actions until complete.

7. Assign subflow outputs to a value.

You can assign a subflow output to multiple values, enabling you to create conditional outputs based on flow logic.

a) Under **Actions**, click + and select **Flow Logic**.

b) Click **Assign Subflow Outputs**.

c) In the **Name** field, select an output you created in the Inputs & Outputs section. You can only assign values to outputs that have already been given a name and data type.

d) In the **Data** field, enter a value or select a data pill from the data panel.

e) Click **Done**.

Test the subflow, and publish it when it is ready to be added to a flow or called from a script.

**Note:** You can only test or publish subflows that contain at least one action.
Test a subflow

You can test a subflow alone, or when added to a flow. When testing a subflow alone, you must define the inputs that the subflow uses in its actions. Because a subflow does not have a trigger, testing a subflow runs the actions using the defined input values. Unless updated, subsequent tests use the same inputs defined in the initial test run.

Role required: flow_designer or admin

Create a subflow that contains at least one action and save it. Flow Designer only tests saved subflows that contain at least one action.

Flow designers should always test flows and subflows on sub-production instances containing relevant demonstration data since testing a subflow creates or changes records on the instance.

1. Navigate to Flow Designer > Designer.
2. Click the subflows tab and open a saved subflow.
3. Click Test.
   The Test Subflow dialog opens.
4. Define input values for the subflow to use in its actions. The values defined are remembered on future test runs.
5. Click Run Test.
6. After the flow executes, click Subflow has been executed. To view the subflow, click here.
   The Execution Details open.

Once the subflow behaves as desired, you can publish the subflow and add it to a flow.

Publish a subflow

Publish a subflow to make it available to other users and to add it to activated flows.

Role required: flow_designer or admin

Create a subflow, test the subflow, and verify that it is working as expected.

When you make changes to a published subflow, the changes remain in the draft state until you publish the subflow again. You must publish a changed subflow to make the changes available to activated flows.

1. Navigate to Flow Designer > Designer.
2. Click the subflows tab and open a tested subflow.
3. Click Publish.

The subflow can be added to activated flows. If you update the subflow after it is published, you must click Publish again to see the changes when the parent flow is run. After publishing changes, all parent flows that use the subflow are automatically updated to use the current version.

Complex data

Use a graphical interface to work with collections of complex structured data. Help design users understand the organization of structured data, and add, remove, or configure its individual elements.

Complex data allows you to encode and store structured data in a machine-readable format such as JavaScript Object Notation (JSON) or eXtensible Markup Language (XML). You can use the Flow Designer interface to view and understand the organization of structured data as well as create data structures. For example, you can create a contact data structure consisting of information you look up from a user record such as first name, last name, and email address.

You can create complex data from these Flow Designer interfaces.
Complex data usage examples

<table>
<thead>
<tr>
<th>Flow Designer interface</th>
<th>Example usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action inputs and outputs</td>
<td>Create an action that generates an object from record data. Populate the object using record data the action looks up. See Create a custom action to generate an object from a record</td>
</tr>
<tr>
<td>Script step input and output variables</td>
<td>Write a script to create an array of objects from a list of records. See Create a custom action to generate an array of objects from a list of records. Write a script to parse a JSON document into an output of type Object.</td>
</tr>
<tr>
<td>Subflow inputs and outputs</td>
<td>Create a subflow that accepts an object as an input and uses it to call an external service.</td>
</tr>
<tr>
<td>XML parser step Target field configurations</td>
<td>Parse an XML payload into a complex data object using the XML parser step.</td>
</tr>
</tbody>
</table>

Benefits

Complex data offers these benefits.

- Parse and format data without having to write code. For example, create data variables to parse a response message or format a request message.
- Create arbitrary data structures. For example, create an issue data structure that combines information from existing interaction and incident records, or create a data structure to support a custom integration.
- View the organization of data structures. For example, an issue data structure might consist of a user object to describe who to contact about the issue and a history object to describe the work done to resolve it. You could configure a notification action with the path to the email address listed in the user object, and call an escalate issue subflow with the path to the status or reassign count from the history object.
- Allow access to data structure from API calls. For example, call an action or subflow from a script and use the predefined data structure as input values.
- Save and reuse data structures as templates. For example, save the user object as a template data structure for reuse in other actions and flows.

Data structure

A data structure is a collection of related data elements organized into a hierarchy. Each element in a data structure has its own data type and its own unique position in the hierarchy.

The Editor pane displays data structure hierarchy with indentation. The indentation level identifies whether an element is a parent, child, or sibling in the hierarchy. Parent elements have children indented underneath them, and siblings have the same indentation level.

Note: The Flow Designer interface allows you to create hierarchies with an unlimited number of child levels, but you may have to scroll horizontally to see them.

For example, this data structure consists of an Employee parent element with four child elements for ID Number, Name, Start Date, and Contact Email. The Contact Email element is also a parent element with one child.
Sample inputs for an Employee object

The Data pane displays data structure hierarchy as a tree of collapsible and expandable data pills just like it does with record variables. Parent elements have an arrow icon to collapse or expand the hierarchy.

For example, here is the Employee data structure as seen from the Data pane.

Sample data pill for an Employee object
You can use the Data pane or Data picker to select specific values from a data structure. Data structures are similar to data pills for records in that you can dot-walk or navigate to specific elements within the structure. When you select a data element, Flow Designer displays the path to it as a data pill just like any other data element selection. For example, if you select the Start Date data element, the path is [Input->Employee->Start Date].

You can use an element data path the same way you can an XPath or JPath. Sometimes you may even convert the data pill path into one of these path notations.

**Complex data types**

You build data structures using one or more **Array** or **Object** variables. Only these variable data types support child variables.

An Array variable contains values for one type of item. The parent variable is always of an Array data type, and there is always only one child variable, which is one instance of the data type supported by the array. Create Array variables when an input or output accepts multiple values of the same data type.

For example, you could create a Contact Email array to list all the email addresses associated with a given person.

<table>
<thead>
<tr>
<th>Component label</th>
<th>Data Type</th>
<th>Sample Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Email</td>
<td>Array.String</td>
<td><a href="mailto:beth.anglin@example.com">beth.anglin@example.com</a> and <a href="mailto:beth@anglin.com">beth@anglin.com</a></td>
</tr>
<tr>
<td>Contact Email_child0</td>
<td>String</td>
<td></td>
</tr>
</tbody>
</table>

An Object variable contains any number and arrangement of child variables that each have their own data type and values. Nesting Object variables allows you to create complex data structures similar to a table schema where one table has related records in another table. Create Object variables when an input or output accepts one or more related properties.

For example, you can create an Employee object to define information about the people who work at a company.
Sample data structure for the Employee object

<table>
<thead>
<tr>
<th>Component label</th>
<th>Data Type</th>
<th>Sample Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Object</td>
<td></td>
</tr>
<tr>
<td>ID Number</td>
<td>Integer</td>
<td>20190304000101</td>
</tr>
<tr>
<td>Name</td>
<td>String</td>
<td>Beth Anglin</td>
</tr>
<tr>
<td>Start Date</td>
<td>Date/Time</td>
<td>March 4, 2019</td>
</tr>
<tr>
<td>Contact Email</td>
<td>Array.String</td>
<td><a href="mailto:beth.anglin@example.com">beth.anglin@example.com</a> and <a href="mailto:beth@anglin.com">beth@anglin.com</a></td>
</tr>
</tbody>
</table>

Only these variable data types can be parents.

**Parent data types**

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array.Array</td>
<td>A container for arrays. Adds a read-only child item of type Array.</td>
</tr>
<tr>
<td>Array.True/False</td>
<td>A container for true/false values. Adds a read-only child item of type True/False.</td>
</tr>
<tr>
<td>Array.Choice</td>
<td>A container for choice values. Adds a read-only child item of type Choice.</td>
</tr>
<tr>
<td>Array.Date/Time</td>
<td>A container for date/time values. Adds a read-only child item of type Date/Time.</td>
</tr>
<tr>
<td>Array.Integer</td>
<td>A container for integer values. Adds a read-only child item of type Integer.</td>
</tr>
<tr>
<td>Array.Object</td>
<td>A container for objects. Adds a read-only child item of type Object, which displays the Add Child Item option.</td>
</tr>
<tr>
<td>Array.String</td>
<td>A container for string values. Adds a read-only child item of type String.</td>
</tr>
<tr>
<td>Object</td>
<td>A container for other data elements. Displays the Add Child Item option.</td>
</tr>
</tbody>
</table>

Array and Object variables only support these child data types.

- Array
- True/False
- Choice
- Date/Time
- Integer
- Object
- String

**Note:** The data types in array and object variables are not Glide elements. There may not be complete compatibility between these items and Now platform types.
Advanced options

Object variables have advanced options to save and load data structures. These options allow you to reuse a data structure defined in one location in another. For details on advanced options see Advanced options for action inputs.

Data structure templates

Data structure templates allow you to reuse Object variables in multiple actions or subflows. For example, you can create a data structure to parse a response and then later reuse that same data structure to format a request. A template stores the list of child variables and their structure within an object. Each Object variable has an Advanced Option to save it as a template.

When you apply a template, you are creating a copy of the original structure. Any changes you make after applying a template do not affect the template, nor do they affect other actions that use the template.

Array data pills

Objects that contain array data may require For Each flow logic to process. For example, a user object that contains an array of email addresses would require a For Each flow logic loop to send a notification to each email address.

Object data pills

You can design actions that accept object data pills as input values. For example, you might create a notification action that accepts a user object as an input. If the user object consists of values for first name, last name, and addresses, then the notification action has access to all these values. To configure an action input with an object data pill, you must create an object earlier in the flow.
**Sample action that accepts an object data pill**

You can use an object data pill or any of its child elements to configure an input. When you configure an input value with an object data pill, Flow Designer makes any child elements of the object read-only, and the action uses the values provided by the object. For example, you can create a flow where one action generates a user object and another action sends a notification to the user specified in the object.
Sample action configured to use an object data pill

When you configure the child elements of an object, you must manually provide data pills for each child element of the object. For example, you can manually configure the user object with record values from an earlier action.

Script support

Create and reference complex data from a script. Use a script when your source data comes from a data stream, a REST step response, or a Look Up Records step. See Script support for complex data for more information about scripting with complex data.
Design considerations

Follow these design guidelines to create reusable and maintainable data structures.

**Minimize the number of child levels in the hierarchy**

The more child levels a data structure has, the more difficult it is to view and select any specific data variable from the hierarchy. While you can build data structures with any number of child levels, it becomes difficult to navigate and understand data structures with more than seven child levels. For the best user experience, avoid creating data structures that have so many child levels you must scroll horizontally to see and populate them.

**Create a separate object for each type of record data**

Most Flow Designer data is record data whether it is from an instance or an external system. This design method ensures that you know what the object contains and where the data came from.

**Recreate record data structures**

When building objects that receive or transmit record data, review the database dictionary entries for these records and create matching object data structures. For example, suppose that you want an object to contain data from incident and configuration item records. You might create a string element for the incident short description field and an array of strings element for the configuration item class field.

**Create objects to combine different types of records**

If you need information from multiple types of records, create an object that contains all the information you need. You can then use the object to format or parse data in Flow Designer.

**Create data structure**

Organize multiple data variables into a structure to process them as a unit and identify the individual items within it.

- Role required: action_designer, flow_designer, or admin
- Set up an application in Guided Application Creator to store Flow Designer content.
- Create an action or Create a subflow

A data structure is a collection of related data elements organized into a hierarchy. Each element in a data structure has its own data type and its own unique position in the hierarchy.

1. Create a data variable.

<table>
<thead>
<tr>
<th>Action or subflow input</th>
<th>Click Create Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action or subflow output</td>
<td>Click Create Output</td>
</tr>
<tr>
<td>XML parser step</td>
<td>See XML parser step</td>
</tr>
</tbody>
</table>

2. Set **Type** to **Object**.

The top level of a data structure hierarchy must be an Object variable.

3. Click the **Add Child Item** icon.

Flow Designer adds a child data variable to the bottom of the object list.

**Note:** You can insert a child item variable between existing variables by hovering your mouse pointer between two variables, and click the insert item icon.
that appears.

**Note:** When hovering your mouse pointer between a child and sibling variable, you will see a add child icon

Click the left side of the icon to add a new sibling variable to the child's parent, or the right side to add another child variable under the current variable.

4. Set the child variable **Label** and **Type**.
   To add another branch to the data structure hierarchy, set the Type to Object.

5. Repeat steps 3-4 for each data variable in the hierarchy.

Use the data structure to populate action, step, or subflow inputs. If you can reuse the data structure, save it as a template.

**Save data structure**

Save the data structure of child variables within an Object variable for later reuse.

- Role required: action_designer, flow_designer, or admin
- Set up an application in Guided Application Creator to store Flow Designer content.
- Create an action or Create a subflow

1. Create data structure.
2. Expand the Advanced options for the Object variable you want to save.
3. Click Save as Template.
   Flow Designer displays a pop-up dialog.
4. Enter the template name.
5. Click **Save**.
   If the template name already exists, Flow Designer displays a confirmation dialog to overwrite the existing template.

Load the data structure in another action or subflow. Make updates to the data structure and save them.

**Load data structure**

Load a data structure of child variables within an Object variable.

- Role required: action_designer, flow_designer, or admin
- Set up an application in Guided Application Creator to store Flow Designer content.
- Create an action or Create a subflow

1. Create a data variable.
2. From **Type**, select **Object**.
3. Expand the Advanced options for the Object variable whose data structure you want to replace.
4. From **Structure**, select **Start from Template**.
   Flow Designer displays the **Template** field.
5. From **Template**, select the template containing the template you want to load.
   If the Object variable has no existing data structure, Flow Designer loads the data structure into it. If the Object variable has an existing data structure, Flow Designer displays a confirmation dialog to replace the existing structure.
**Create a custom action to generate an object from a record**

Generate an object from a User record. Learn how to use an Action output to create an object from record values.

Role required: admin

Use this example to see demonstrations of these operations and steps.

- Create action inputs for the User record fields First name, Last name, and Email.
- Lookup a User record matching the action input values.
- Create an action output for a contact object.
- Save the contact object as a template.
- Map contact object values to User record field values.
- Test the action with a sample user.

1. Create an application to store your work.
   Use the Guided Application Creator.
   For example, create My Application.

   The system displays the Flow Designer landing page.

   The system displays the Action Properties dialog.

4. Enter these sample values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Create Contact Object From User</td>
</tr>
<tr>
<td>Application</td>
<td>My Application</td>
</tr>
<tr>
<td>Accessible From</td>
<td>All application scopes</td>
</tr>
</tbody>
</table>

5. Select Submit.
   The system displays the Action Designer interface.

6. From the Action Outline, select Inputs > Create Input.
   The system displays a new action input.

7. Configure the action input with these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>First name</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
</tr>
<tr>
<td>Mandatory</td>
<td>True</td>
</tr>
</tbody>
</table>

8. From the Action Outline, select Inputs > Create Input.
   The system displays a new action input.

9. Configure the action input with these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Last name</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
</tr>
<tr>
<td>Mandatory</td>
<td>True</td>
</tr>
</tbody>
</table>
10. From the Action Outline, select Inputs > Create Input
    The system displays a new action input.
11. Configure the action input with these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Email address</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
</tr>
<tr>
<td>Mandatory</td>
<td>False</td>
</tr>
</tbody>
</table>

12. From Action Outline, select Outputs > Create Output.
    The system displays a new action output.
13. Configure the output variable with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>contact</td>
<td>contact</td>
<td>Object</td>
<td>False</td>
</tr>
</tbody>
</table>

14. From the row for the contact Object, select Add Child Item.
15. Configure the child item with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>first_name</td>
<td>String</td>
<td>True</td>
</tr>
</tbody>
</table>

16. From the row for the contact Object, select Add Child Item.
17. Configure the child item with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last name</td>
<td>last_name</td>
<td>String</td>
<td>True</td>
</tr>
</tbody>
</table>

18. From the row for the contact Object, select Add Child Item.
19. Configure the child item with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email address</td>
<td>email_address</td>
<td>String</td>
<td>False</td>
</tr>
</tbody>
</table>
26. Select **Save**.
27. Select **Test**.
   The system displays the Test Action dialog.
28. Enter these test values.

<table>
<thead>
<tr>
<th>Input</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>Abel</td>
</tr>
<tr>
<td>Last name</td>
<td>Tuter</td>
</tr>
</tbody>
</table>

29. Select **Run Test**.
   The system runs the action with the test values provided.

30. **Select Action has executed. To view the action, click here.**
   The system displays the action execution details.

31. **Review the runtime value for the action Output data.**
   The system displays output data in JSON format.
   For example, sample contact object JSON for the user Abel Tuter.

```
{
  "contact": {
    "email_address": "abel.tuter@example.com",
    "last_name": "Tuter",
    "first_name": "Abel"
  }
}
```

You have a custom action that looks up a User record and converts it into a contact object.
Customize the action to use your own logic.

**Create a custom flow to generate an object for each record in a list**

Generate an object for each User record in a list. Learn how to use flow logic to iterate through a list of records.

- **Role required:** admin
- **Create a custom action to generate an object from a record**

Use this example to see demonstrations of these operations and steps.

- Create a flow that runs on a daily schedule.
- Look up User records filtered by the Department provided as an input.
- Add flow logic that runs for each User record you looked up previously.
- Create a contact object for each User record using the custom action you created previously.
- Create a log message for each User record.

1. **Navigate to Flow Designer > Designer.**
   The system displays the Flow Designer landing page.
2. **Select New > Flow**
The system displays the Flow Properties dialog.

3. Enter these sample values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Create Contact Objects From Users</td>
</tr>
<tr>
<td>Application</td>
<td>My Application</td>
</tr>
<tr>
<td>Run As</td>
<td>User who initiates session</td>
</tr>
</tbody>
</table>

4. Select **Submit**.
The system displays the Flow Designer interface.

5. Select **Click to add a Trigger > Date > Daily**.

6. Select **Done** to close the trigger.

7. Select **Click to add an Action, Flow Logic, or Subflow > Action > ServiceNow Core > Look Up Records**.
The system adds the action to the flow.

8. For **Table**, select **User [sys_user]**.

9. For **Conditions**, add these values.
   • `[Department][is][Development] [AND]
   • `[Email][is not empty]

10. Configure these field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order by</td>
<td>Name</td>
</tr>
<tr>
<td>Sort</td>
<td>a to z</td>
</tr>
<tr>
<td>Max Results</td>
<td>1000</td>
</tr>
</tbody>
</table>

11. Select **Done** to close the action.

12. Select **Click to add an Action, Flow Logic, or Subflow > Flow Logic > For Each**.
The system adds the flow logic to the flow.

13. For **Items**, select **[1->User Records]**.

   **Note**: You can select the Action 1 **User Records** data pill from the Data pane or from the Data Pill Picker button.

14. Select **Done** to close the flow logic.

15. Select the plus icon to add a child item to the For Each flow logic.

16. Select **Action > My Application > Create Contact Object**.

17. For **userRecord [User]**, select **[2->User Record]**.

   **Note**: You can select the Action 2 **User Record** data pill from the Data pane or from the Data Pill Picker button.

18. Select **Done** to close the flow logic action.

19. Select the plus icon to add a child item to the For Each flow logic.

20. Select **Action > ServiceNow Core > Log**.

21. For **Message**, select **[2.1->contact]**.

   **Note**: You can select the Action 2.1 **contact** data pill from the Data pane or from the Data Pill Picker button.
22. Select **Done** to close the flow logic action.
23. Select **Save**.

**Script support for complex data**

Create and reference complex data from a script. Use a script when your source data comes from a data stream, a REST step response, or a Look Up Records step.

Use script to create complex data when data comes from these sources.

<table>
<thead>
<tr>
<th>Data source</th>
<th>Create/map complex data from</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Stream action response stream</td>
<td>Script Parser step</td>
</tr>
<tr>
<td>REST step response</td>
<td>Script step</td>
</tr>
<tr>
<td>Look Up Records step</td>
<td></td>
</tr>
</tbody>
</table>

**Data Stream action response stream**

Data Stream actions use a parser script to map stream item values to complex object values. When writing a parser script, use JavaScript methods appropriate to the data stream format. For example, use the `JSON - Scoped` class to parse or encode a JSON data stream.

Parser scripts have access to the data stream input and output objects as well as a `targetObject` property. See **Data Stream actions** for more information about parsing a response stream to create complex data.

**REST step response**

You can convert a REST step response into one or more complex objects by parsing it with a Script step. To access a response from a Script step, you must create an input script variable and map it to the response payload from the prior REST step. See **Script step** for more information about creating script input variables.

Write a script that maps REST response values to complex object values. When writing REST response script, use JavaScript methods appropriate to the response format such as the `JSON parse()` method.

**Note:** When you use complex data as the source of a string input, Flow Designer automatically converts it into a JSON string.

You do not need to use a Script step to create a REST request from complex data. You can generate complex data in a prior action or step and then map it to a string input of the REST step. At run time, the action or flow converts the complex data into a JSON representation.

**Look Up Records step**

While flows can use **For each** flow logic to process a list of records, actions require a Script step. The Script step replaces the **For each** flow logic with JavaScript such as a **For** or **While** loop.

To access record data from a Script step, you must create an input script variable and map it to the record data from the prior look up step. See **Script step** for more information about creating script input variables.

See **Create a custom action to generate an array of objects from a list of records** for an example action that converts a list of user records into an array of contact objects.
Note: The Look Up Records action does not require a Script step to convert record data into complex data. You can create a custom action to convert a record into an object and apply For each flow logic to the custom action. See Create a custom action to generate an object from a record and Create a custom flow to generate an object for each record in a list for an example of creating a complex object without using script.

Dot-walking object structures

You can reference elements from the structure of an object by dot-walking the path of the structure. All complex data paths start with the name of the data source, which is either the global object for inputs, the global object for outputs, or the name of the array or object you created in script.

Next in the path are the names of each structural element referenced separated by period characters (also known as dots). Listing the names of structural elements is identical to dot-walking a reference field where you list the table structure to a particular reference field.

Note: A dot-walk path always lists the name of a structural element rather than its label.

For example, suppose that you define a contact object as an Output variable. The object has the following structure.
### Output Variables

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact</td>
<td>contact</td>
<td>Object</td>
<td></td>
</tr>
<tr>
<td>First name</td>
<td>first_name</td>
<td>String</td>
<td></td>
</tr>
<tr>
<td>Last name</td>
<td>last_name</td>
<td>String</td>
<td></td>
</tr>
<tr>
<td>Email Addresses</td>
<td>email_addresses</td>
<td>Array.Object</td>
<td></td>
</tr>
<tr>
<td>Email Address</td>
<td>email_address</td>
<td>Object</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>type</td>
<td>Choice</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td>email</td>
<td>String</td>
<td></td>
</tr>
<tr>
<td>Telephone Numbers</td>
<td>telephone_numbers</td>
<td>Array.Object</td>
<td></td>
</tr>
<tr>
<td>Mailing Addresses</td>
<td>mailing_addresses</td>
<td>Array.Object</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The dot-walk path to the **First name** structural element would be `outputs.contact.first_name` while the path to the **Email** structural element would be `outputs.contact.email_addresses[0].email` since you must specify an individual element of the array by its JavaScript index value.

**Note:** A dot-walk path omits the name of the repeated element within the array. For example, an array of objects does not have to specify the object element name. However, since objects are containers for other elements, you can specify a child element of the object within a dot-walk path.

### Design considerations

Keep these design considerations in mind when scripting with complex data.

#### Use string inputs to convert complex data into a JSON string

When you map complex data to a string input, Flow Designer automatically converts it into a JSON string. Instead of writing a script, you can add a string input to a REST step and map it to complex data from a prior action or step.

#### Save your objects as templates

Save your objects as templates so you can reuse them in other actions, flows, and Script steps.

#### Create script input variables to access prior data

Create a script input variable for any data you want to access from the action input or a prior step. Map the script input variable to the input or step data pill. For example, map the script input variable to a list of user records you looked up in a prior step.

#### Create a script output variable to store complex data

Create a script output variable to store any complex data your script creates. The script output variable data structure, data types, and names must match the values defined in the script. For example, create a contacts array of objects to store multiple contact objects. Save the contact object as a template so you can reuse it.

#### Map the action output to the script output variable

When you want a custom action to output complex data, add an action output and map it to the data pill for your Script step output variable. For example, create a contacts array and load the contact object template you saved earlier. Map the action output to the contacts array produced by your Script step.
Create a custom action to generate an array of objects from a list of records

Generate an array of objects from a list of User records. Learn how to use a Script step to iterate through a list of records.

Role required: admin

Use this example to see demonstrations of these operations and steps.

- Create an action input for a Department record.
- Look up a maximum of three User records for the Department action input.
- Configure a Script step to process a list of User records.
- Create a script input variable containing the list of User records.
- Write script that creates an empty contacts array.
- Write script that iterates through the list of User records.
- Write script that creates a contact object and maps User record field values to the contact object.
- Write script that populates the contacts array with the current contact object.
- Create script output variables for the contacts array and child contact object.
- Save the contact object as a template.
- Output the generated contacts array of objects as a data pill.
- Test the action with a sample department.

1. Create an application to store your work.
   Use the Guided Application Creator.
   For example, create My Application.

   The system displays the Flow Designer landing page.

3. Select New > Action
   The system displays the Action Properties dialog.

4. Enter these sample values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Create Contacts Array Of Objects</td>
</tr>
<tr>
<td>Application</td>
<td>My Application</td>
</tr>
<tr>
<td>Accessible From</td>
<td>All application scopes</td>
</tr>
</tbody>
</table>

5. Select Submit.
   The system displays the Action Designer interface.

6. From the Action Outline, select Inputs > Create Input
   The system displays a new action input.

7. Configure the action input with these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Department</td>
</tr>
<tr>
<td>Type</td>
<td>Record.Department [Reference.cmn_department]</td>
</tr>
<tr>
<td>Mandatory</td>
<td>True</td>
</tr>
</tbody>
</table>

8. From the Action Outline, select Add a new step.
   The system displays a list of available steps.

9. Select Look Up Records
10. Configure the step with these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>User [sys_user]</td>
</tr>
<tr>
<td>Conditions</td>
<td>[Department][is][action-&gt;Department]</td>
</tr>
<tr>
<td>Order by</td>
<td>Name</td>
</tr>
<tr>
<td>Sort Type</td>
<td>a to z</td>
</tr>
<tr>
<td>Max Results</td>
<td>3</td>
</tr>
</tbody>
</table>

**Note:** This example limits the **Max Results** setting to three records just for demonstration purposes.

11. From the Action Outline, select **Add a new step**.
   The system displays a list of available steps.
12. Select **Script**.
13. For **Required Runtime**, select **Instance**.
14. From the Input Variables section, select **Create Variable**.
15. Configure the input variable with these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>userRecords</td>
</tr>
<tr>
<td>Value</td>
<td>[step-&gt;Look Up Records step-&gt;Records]</td>
</tr>
</tbody>
</table>

**Note:** You can select the **User records** data pill from the Data pane or from the Data Pill Picker button.

16. For **Script**, enter the following text.

   ```javascript
   (function execute(inputs, outputs) {
       // Create an empty array
       var contactsArray = [];
       var i = 0;
       // Iterate through the list of User records
       while (inputs.userRecords.next()) {
           // Create an empty object for each iteration
           var contactObject = {};
           // Query User records to assign object values
           contactObject.first_name = inputs.userRecords.getValue('first_name');
           contactObject.last_name = inputs.userRecords.getValue('last_name');
           contactObject.email = inputs.userRecords.getValue('email');
           // Add current object to array
           contactsArray[i] = contactObject;
           i += 1;
       } 
       outputs.contacts = contactsArray;
   })(inputs, outputs);
   ```

17. From Output Variables, select **Create Variable**.
18. Configure the output variable with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>contacts</td>
<td>contacts</td>
<td>Array.Object</td>
<td>True</td>
</tr>
</tbody>
</table>

19. Expand the contacts Array.Object, and rename the child item as contact.

20. From the row for the contact Object, select **Add Child Item**.

21. Configure the child item with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>first name</td>
<td>first_name</td>
<td>String</td>
<td>True</td>
</tr>
</tbody>
</table>

22. From the row for the contact Object, select **Add Child Item**.

23. Configure the child item with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>last name</td>
<td>last_name</td>
<td>String</td>
<td>True</td>
</tr>
</tbody>
</table>

24. From the row for the contact Object, select **Add Child Item**.

25. Configure the child item with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>email address</td>
<td>email_address</td>
<td>String</td>
<td>True</td>
</tr>
</tbody>
</table>

26. From the row for the contact Object, select **Toggle Advanced Inputs**.

27. From the Advanced Options, select **Save As Template**.
   The system displays the Save As Template dialog.

28. For **Enter a Name**, enter *contact*.

29. Click **Save**.

30. From the Action Outline, select **Outputs > Create Output**.

31. Configure the Action Output with these values.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>contacts</td>
<td>contacts</td>
<td>Array.Object</td>
<td>True</td>
</tr>
</tbody>
</table>

32. Expand the contacts Array.Object.

33. From the row for the contact Object, select **Toggle Advanced Inputs**.

34. From the Advanced Options, select **Structure > Start from Template**.
   The system displays **Template**.

35. For **Template**, select the template you previously saved.
   For example, select *My application: contact*.

36. Select **Exit Edit Mode**.
   The System displays the output fields you created.

37. For **contacts**, select **[step->Script step->contacts]**.
   
   **Note:** You can select the Script step **contacts** data pill from the Data pane or from the Data Pill Picker button.

38. Click **Save**.

39. Select **Test**.
   The system displays the Test Action dialog.
40. Enter the following test value:

<table>
<thead>
<tr>
<th>Input</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>Development</td>
</tr>
</tbody>
</table>

41. Select **Run Test**.
The system runs the action with the test values provided.

42. Select **Action has executed. To view the action, click here**.
The system displays the action execution details.

43. Review the runtime value for the action **Output data**.
The system displays output data in JSON format.

For this example, the contacts object contains an array of contact objects with first name, last name, and email information for three users in the Development department.

```json
{
  "contacts": [  
    {
      "email_address": "allyson.gillispie@example.com",
      "first_name": "Allyson",
      "last_name": "Gillispie"
    },
    {
      "email_address": "alva.pennigton@example.com",
      "first_name": "Alva",
      "last_name": "Pennigton"
    },
    {
      "email_address": "andrew.och@example.com",
      "first_name": "Andrew",
      "last_name": "Och"
    }
  ]
}
```

You have a custom action that looks up the Users for a given department and converts those users into an array of contact objects.

Customize this action to use your own logic.

**Inline scripts**

Enable users with coding experience to write inline scripts that set and modify input values during the configuration of an action or flow. Use inline scripts to modify input values that require small format conversions, data transformations, or math operations.

Flow Designer displays a Script button when you configure these components.

- Action instance inputs when you configure the action for a flow
- Action instance outputs when you configure the action for a flow
- Flow logic inputs when you configure the flow logic for a flow
- Flow logic outputs when you configure the flow logic for a flow
- Step inputs when you configure the step for an action
- Subflow inputs when you configure the subflow for a flow
- Subflow outputs when you configure the subflow for a flow
Inline scripts must return values in the same data type as the input expects. For example, an inline script for a Record input must return a GlideRecord object and an inline script for a Date input must return a date-time value. Always test actions and flows containing inline scripts, and verify that there are no runtime errors in the flow execution details.

Script writers should be familiar with Now Platform table structures and field types. In addition, they should know how to work with record and system data using the ServiceNow API.

Benefits

Inline scripts offer these benefits.

- Enable simple data conversion or transformation without having to create custom actions or flows.
- Identify which input data a script affects.
- Restricted access to scripting features to users or groups who are knowledgeable with the available ServiceNow APIs.

Access to inline script

You can grant users access to online scripting by either granting them the flow_designer_scripting role or the Allow Scripting delegated development permission. Both the role and the developer permission display a script button field for each Flow Designer input.

Script button

When you enable a user to create inline scripts, Flow Designer displays a script button next to flow and step inputs.
Clicking the **Script** button opens the Script editor, which replaces the standard input interface. Enter a script to compute the input value. Script writers can use the `fd_data` object to access data from previous actions and steps. Ensure your script includes a `return` statement with the results of your script. For example, `return shortDesc;` returns the value of the `shortDesc` variable.

**Script editor for input**

Clicking the **Collapse Script** button hides the Script editor and displays a read-only version of the input. Clicking the **Expand Script** button displays the Script editor and allows you to edit the script.
Design considerations

Follow these design guidelines to create reusable and maintainable inline scripts.

**Write inline script for small non-reusable logic**

Use inline script to format or modify the data for specific inputs and use cases. For reusable logic, create an action or subflow instead.

**Create custom actions or subflows for reusable code rather than inline script**

Create custom actions or subflows for reusable or complex data logic such as changing the data type of source data. You may also want to provide custom actions or subflows for flow designers who are not comfortable with code.

**Avoid duplicating action and flow functionality**

Avoid writing inline script that duplicates action and flow functionality. For example, rather than write inline script to perform record operations, use the create and update record baseline actions.

**Avoid data type changes**

Avoid runtime errors by verifying that your inline script provides information in the same data type as the input or output expects.

**Create variables by declaring them with the var keyword**

Use the `var` keyword to declare variables so that they remain within the proper JavaScript scope. When you create a variable by assigning it a value, JavaScript may attach it to the global object, which can result in variable values persisting outside of the local scope and causing errors.

**Process records outputs with For Each flow logic and the flow data object**

Inline script can only access the `records` output of a Look Up Records action from For Each flow logic. Add a Look Up Records action to the flow to generate the records output. Add a For Each flow logic to the flow to process each record in the records output. Create an inline script reference to the For Each flow
logic using the fd_data and item objects. For example, this reference assumes the For Each flow logic is the second item in your flow outline $fd_data._2__for_each.item$.

**Use type ahead suggestions to generate references to flow and action data.**

Create references to flow and action data using the fd_data object. The script editor displays type ahead suggestions for existing flow and action data when you type $fd_data$. Select a suggestion to build references to flow and action data.

![Note: Refer to record data in a For Each flow logic using the item object.](image)

**Licensing considerations**

Inline scripts that call integration APIs are subject to IntegrationHub licensing.

**Code editor**

The code editor provides text editor support for inline scripts.

The code editor has these features for the supported language services and scripts.  
- Syntax coloring, indentation, line numbers, and automatic creation of closing braces and quotes  
- Auto-suggestions and auto-completions

```
/*
**Access Flow/Action data using the fd_data object. Script must return a value.
**example: var shortDesc = fd_data.trigger.current.short_description;
**return shortDesc;
*/
return(Math.sqrt(64));
```

**Editing tips**

- To insert a fixed space anywhere in your code, press Tab.  
- To indent a single line of code, click in the leading white space of the line and then press Tab.
• To indent one or more lines of code, select the code and then press Tab. To decrease the indentation, press Shift+Tab.
• To remove one tab from the start of a line of code, click in the line and press Shift+Tab.
• To declare variables, use the `var` keyword so that they remain within the proper JavaScript scope.

**Action Designer**

Automate a task with a sequence of related steps such as lookup a record, create a record, and log details about the record creation. Actions separate complexity from the Flow Designer environment, enabling flow designers to add actions to multiple flows with minimal configuration.

Using Action Designer, subject matter experts can:

• Create application-specific actions with pre-set configuration details, enabling process analysts to easily add actions to a flow with little configuration.
• Create scripted actions that appear code-less when added to a flow.
• Build integrations using IntegrationHub.

**Custom actions**

Unlike core actions where flow designers must manually configure flow logic, custom actions always use the same configuration when added to a flow. If your flow designers often use an action with the same configuration, you might create a reusable action.

A reusable action includes these components.

**Inputs**

*Inputs* are data variables used in your action. For example, if an action step creates a record in the incident table, your input might be a reference to the incident table. Once added as an input, the table and its fields are available to steps and outputs in the flow.

Each input you define for an action becomes a configuration option in the Flow Designer interface. To use the action in a flow, flow designers must define a value for each mandatory input. The more inputs an action has, the more data flow designers must define and the more familiar they must be with the underlying data model to use the action effectively.

Inputs provide advanced options based on their data type. All inputs have advanced options to add a hint or provide a default value. Use advanced options to guide flow designers through adding and configuring an action to a flow. For example, create a choice input to provide flow designers with a pre-defined list of configuration options to choose from. For more information about the configuration options available to particular data types, see field types.

**Action steps**

An *action step* or step is a single reusable operation within an action. For example, the Create Record step allows action designers to specify the table and field values to use during record creation. Action steps require subject matter expertise with application tables, fields, and business logic. Application developers or IT generalists add action steps to actions from the Action Designer design environment. Flow Designer provides a set of core action steps to automate Now Platform processes. You can add application-specific action steps by activating the associated spoke.

**Outputs**

*Outputs* are data variables that represent the results of the action. These results are available to other actions in a flow.
**Action Designer environment**

Subject matter experts build custom actions in Action Designer.

Create and edit actions by defining inputs and adding action steps. Test actions to verify if they complete successfully and review the runtime values they generate. Copy actions to use existing actions as templates. Publish actions to activate them, which makes them available to activated flows and to preserve their current action steps, variables, and sequence as a snapshot separate from further configuration changes.

**Testing actions**

After adding inputs and action steps, users with the flow_designer role can test an action. To test an action, users must provide the required inputs.

- **Note:** Inputs must be provided for all the mandatory fields.

Flow designers should always test actions on non-production instances containing relevant demonstration data since testing an action creates or changes records on the instance.

- **Note:** User must have the flow_designer or admin role to view the executions.

**Roles**

To create custom actions, a user must have the action_designer or admin roles.

**Action input and output data types**

You can define input variables for your Flow Designer actions. Input variables and data used in action steps can be defined as output variables.

Action inputs are data variables with a name and data type. You must associate some data types with a reference table, which makes the record and fields available to the action steps. Available data types include:
- Array
  - Array.Boolean
  - Array.Choice
  - Array.Datetime
  - Array.Integer
  - Array.Object
  - Array.String
- Audio
- Choice
- Color
- Condition String
- Conditions – Reference table required
- Currency
- Data Structure
- Date
- Date/Time
- Document ID – Reference table required
- Due Date
- Duration
- Dynamic Choice
- Dynamic Template
- Encrypted Text
- Field Name
- Floating Point Number
- HTML
- IP Address (Validated IPV4, IPV6)
- Icon
- Image
- Integer
- Journal
- Journal Input
- Journal List
- List
- Long
- Name-Value Pairs
- Password (1 Way Encrypted)
- Password (2 Way Encrypted)
- Percent Complete
- Phone Number (E164)
- Price
- Records – Reference table required
- Reference – Reference table required
- Script
- Script (Plain)
- String
- String (Full UTF-8)
- Table Name
- Template Value – Reference table required
- Time
Advanced options for action inputs

Use advanced options to further configure your inputs.

All

The following options are available for all advanced inputs.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the array in script calls.</td>
</tr>
<tr>
<td>Hint</td>
<td>Text to display to flow designers so they know what information the array contains.</td>
</tr>
<tr>
<td>Default Value</td>
<td>The value used when an input value is not provided. For example, the default selection of a choice field or a default string in a string field.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>The input requires a value.</td>
</tr>
</tbody>
</table>

Some action inputs have additional options. The details of these options are listed below.

Array

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Rows</td>
<td>The maximum number of rows you want to display in the user interface. This does not set a limit on the maximum number of rows in the array object.</td>
</tr>
</tbody>
</table>

Array.Choice

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max length</td>
<td>The maximum length the system stores for an input choice value. Use this option to restrict the length of input values stored during action design.</td>
</tr>
<tr>
<td>Choice</td>
<td>Select from:</td>
</tr>
<tr>
<td></td>
<td>• Dropdown with --None--</td>
</tr>
<tr>
<td></td>
<td>• Dropdown without --None--</td>
</tr>
</tbody>
</table>
### Choice list

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice list</td>
<td>Select from:&lt;br&gt;• <strong>Create New Choice list</strong> to manually create choices. Use the add button (+) to create a choice with <strong>Name</strong>, <strong>Value</strong>, and <strong>Order</strong> values.&lt;br&gt;• <strong>Reference existing choice list on a table</strong> to select a choice list from and field on an existing table using the <strong>Choice Table</strong> and <strong>Choice field</strong> buttons.</td>
</tr>
</tbody>
</table>

### Array.Object

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure</td>
<td>Select from:&lt;br&gt;• <strong>Create Structure Manually</strong>&lt;br&gt;• <strong>Start from Template</strong></td>
</tr>
<tr>
<td>Template</td>
<td>Select a template to use for this array.</td>
</tr>
<tr>
<td>Save as Template</td>
<td>Save the current array as a template.</td>
</tr>
</tbody>
</table>

### Array.String

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Length</td>
<td>The maximum length the system stores for an input string value. Use this option to restrict the length of input values stored during action design.</td>
</tr>
</tbody>
</table>

### Password (2 Way Encrypted) design considerations

Follow these guidelines when designing flows containing Password (2 Way Encrypted) data.

- To specify the encryption algorithm and the roles allowed to access encrypted data, see Setup encryption contexts.
- Flow Designer prevents manual entries in Password (2 Way Encrypted) values in flow inputs.
- Fields containing Password 2 data cannot be used in conditions.
• To assign a value to a password2 field, drag an existing password2 data pill. Dragging values from other field types is not supported. Flow Designer presents a warning message when password2 data is required.

• Flow Designer prevents dragging Password2 data pills into other field types, and presents a warning message when the field is incompatible type.

• Flow Designer only allows Password2 data pills to be dragged into the following field types.
  • Email body fields
  • HTML fields
  • Password 2 Fields
  • PowerShell Input Variables
  • REST fields
    • Variables
    • REST payload body
    • Query parameters
    • Headers
    • REST multi-part form values
    • Form URL-encoded values
  • SOAP fields
    • Headers
    • Envelope

Flow Designer performs a validation check when a user saves, publishes, or tests actions and flows. This check shows an alert for any data pills dropped in restricted field types and prevents the action or flow from executing. Update the action or flow to remove the invalid data pill and then retry the action.

**Retry policy**

Automatically retry failed requests when a step encounters an intermittent issue such as a network failure or request rate limit. Set a retry policy to prevent having to manually triggering the step again.

**Features**

Retry policies can be:
• Created to support connection timeouts or failed requests based on header, status, response body, error, and HTTP method.
• Applied to all actions that use a given connection alias.
• Applied directly to an action step

Retry policies can be used to define:
• The conditions that must be met to retry a step.
• The time interval to wait before retrying a step.
• The maximum number of retry attempts the step makes before stopping.

Associate a default retry policy to a Connection & Credentials alias and apply the retry policy to all HTTP connections.

Note: You can only create retry policies for REST and SOAP steps.

Create a retry policy
Create a retry policy to automatically retry failed requests when a step encounters an intermittent issue.
Role required: flow_designer or admin
1. Navigate to IntegrationHub > Retry Policy > Create New.
2. On the form, fill in the fields.

Retry Policy form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the retry policy.</td>
</tr>
<tr>
<td>Connection Type</td>
<td>HTTP</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that must be met to trigger the retry policy. Conditions that trigger a retry policy include the is, is not, contains, and contains not operators.</td>
</tr>
</tbody>
</table>
| Retry Strategy    | • Exponential Backoff: Option to exponentially increase the time interval for the subsequent retry attempts. The multiplier is 2.  
|                   | • Fixed Interval: Option to specify a fixed time interval after which a retry attempt should be made. |
| Interval (seconds)| Time interval in seconds after which a retry attempt should be made.        |

Note: If Retry Strategy is Exponential Backoff, the time interval exponentially increases after every retry attempt till the maximum numbers of attempts is reached.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>Maximum number of retry attempts. If no value is specified, the maximum number of retry attempts is based on the value provided in the <code>glide.fdih.retry.max_count</code> system property. Default value of the <code>glide.fdih.retry.max_count</code> system property is 0. For more information about system properties, see <a href="#">Available system properties</a>.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
Retry policy with Retry Strategy as Exponential Backoff

In this example, the policy is defined to attempt retry when one of these conditions is met:

- HTTP Method is GET and Error is Connection Timeout
- HTTP Method is GET and Status Code is 429
When the condition is met, retry attempts are made for a maximum number of three times. The time interval between the retry attempts is exponentially increased. The time intervals in this example are 10 seconds, 20 seconds, and 40 seconds.

- Create Connection & Credential alias, if you do not have the required alias.
- Assign the retry policy as **Default Retry Policy** to the required Connection & Credential alias.

**Note:** A default retry policy is provided and is selected as **Default Retry Policy**. If you have created retry policies, you can select the required policy as **Default Retry Policy**.

- Create an HTTP(s) Connection in the Connections related list for the Connection & Credential alias. For more information, see credentials, connections, and aliases.
- Verify and view the details of the retry attempts by navigating to **System Logs > Outbound HTTP Requests**.

**Dynamic inputs**

Build dynamic choice and template inputs for an action. Dynamically display and assign values to the inputs during flow design.

**Note:** Dynamic inputs are not available in the base system. To use dynamic inputs in Flow Designer, you must request a ServiceNow® IntegrationHub Enterprise Pack subscription.

During flow design, dynamic inputs retrieve values and display them as inputs within an action dynamically. Dynamic input types include:

- Dynamic choice
- Dynamic template

A dynamic input must point to a data gathering action that collects the data it displays. For example, a data gathering action can retrieve values from a third-party system and populate a dynamic choice for an action that runs in an IntegrationHub spoke. To use a dynamic input in Flow Designer:

1. An action designer creates a data gathering action.
2. An action designer creates a parent action with a dynamic input that points to the child data gathering action.
3. A flow designer adds the parent action to a flow.

**Data gathering actions**

A data gathering action collects data, typically from a third-party system via a REST call, and dynamically builds its output based on the returned payload. A data gathering action must:

- Have a **script step** that contains an output variable of type JSON.
- Have an action output named **output** of type JSON whose value is derived from the script step's JSON output variable.

**Note:** The action can have multiple outputs, but there can only be one of type JSON.

- Format the payload in the script step so that **output** has a property named **data**.
• Wait for up to 300 seconds (5 minutes) to gather data before it times out.

**Note:** To change the timeout period for a data gathering action, modify the value of the `sn_flow_designer.sync_action_execution_timeout_in_seconds` system property.

### Dynamic choice

A dynamic choice displays gathered data as a list of choice values during flow design. For more information on building a dynamic choice, see Create a data gathering action for a dynamic choice.

### Dynamic template

A dynamic template displays a gathered list of fields whose associated values can be specified during flow design. Since the list of fields populates using a dynamic action, there is no need to change the flow if new fields are added to or removed from the table accessed in the data gathering action. For more information on building a dynamic template, see Create a data gathering action for a dynamic template.

### Design considerations

#### Consider dynamic inputs for third-party integrations

Dynamic inputs allow you to create flows that fetch data dynamically from external sources. In third-party integrations, dynamic inputs can provide data values pertaining to a particular endpoint. For more information on setting up third-party integrations with Flow Designer, see IntegrationHub.

#### Be aware of time required to retrieve large amounts of data

By default, dynamic inputs have up to 300 seconds to gather data before they time out. If your data gathering action needs more time to gather data, set the `sn_flow_designer.sync_action_execution_timeout_in_seconds` system property to a higher value. Long timeout values are not recommended for interactive flows where an end user must enter or select a value for the flow to continue.

#### Be aware of scripting errors

Since all data gathering actions use a script step, be aware of any potential errors that could arise from scripting. When using scripts to output JSON variables for your dynamic inputs, you may encounter errors which prevent inputs from receiving the JSON values they need. When a dynamic input scripting error occurs, the following warning message may appear.

![Warning: A dynamic action error occurred.](image)

**Message displayed for scripting error**

### Getting started with dynamic inputs

Create a sample action that builds a dynamic choice and dynamic template for use in a flow.
Role required: action_designer or admin

In this task, you will create a custom action that dynamically generates a list of tables and associated fields in your instance. To accomplish this, you will create two data gathering actions: one that collects a list of tables in your instance, and another that collects a list of fields for the selected table. Each data gathering action will consist of the following:

- A REST step to gather table and field data from your instance.
- A script step to construct the payload from the REST step’s Response Body.
- An output variable named output of type JSON.

You will then use these data gathering actions to build a dynamic choice and a dynamic template. Finally, you will create a custom action that calls the data gathering action during flow design.

Note: This task recreates the demo actions that are installed when you request a ServiceNow® IntegrationHub Enterprise Pack subscription for your instance.

1. Navigate to Flow Designer > Designer.
2. Click the New button and select New Action.
   a) Enter Get ServiceNow Tables (Dynamic) for the Name.
   b) Click Submit.
3. Under Action Outline, click the Add a new step(+) icon under Inputs and select the REST step. Enter the following information.

<table>
<thead>
<tr>
<th>Input</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Leave Use Connection Alias selected</td>
</tr>
<tr>
<td>Connection Alias</td>
<td></td>
</tr>
<tr>
<td>Build Request</td>
<td>Leave Manually selected</td>
</tr>
<tr>
<td>Resource Path</td>
<td>Enter api/now/doc/table/schema</td>
</tr>
<tr>
<td>HTTP Method</td>
<td>Enter GET</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
4. Under **Action Outline**, click the **Add a new step** icon under your REST step and select the **Script** step.
   a) In the **Input Variables** section, click **Create Variable**.
   b) Enter **payload** as the **Name**.
   c) For the **Value**, click the data pill picker and select **REST Step > Response Body**.
   d) Enter the following code for the **Script**.

```javascript
(function execute(inputs, outputs) {
    var payload = JSON.parse(inputs.payload);
    var tables = payload.result
        .filter(function(table) { return table.value.indexOf('_') < 0; }) // Filter the tables we want
        .map(function(table) {
            return { label: table.label, name: table.value }; // Final, properly formatted output
        });
    outputs.tables = { data: tables }; // Final, properly formatted output
})(inputs, outputs);
```

   e) In the **Output Variables** section, click **Create Variable**.
   f) Enter **tables** for the **Label** and **Name**.
   g) Select **JSON** as the **Type**.

5. Under **Action Outline**, click **Outputs**.
   a) Click **Create Output**.
   b) Enter **output** for the **Label** and **Name**.
   c) Select **JSON** as the **Type**.
   d) Click **Exit Edit Mode**.
   e) For the **Value**, click the data pill picker and select **Script Step > tables**.

6. Click **Save** and then **test the action**.
   a) Click **Run Test**.
   b) Check the action’s execution details. Your data gathering action runs successfully if the runtime value for **tables** is a complex object containing an array of key-value pairs for **label** and **name** as shown in the following abbreviated example.

```json
{
    "data": [
        {
            "name": "sla",
            "label": "Agreement"
        },
        {
            "name": "announcement",
            "label": "Announcement"
        },
        {
            "name": "cmdb",
            "label": "Base Configuration Item"
        }
    ]
}
```
7. Click **Publish** to make the **Get ServiceNow Tables (Dynamic)** action available to other flows and actions within the **Global** scope.

8. Click the **Create flow, subflow, or action** icon and select **Action**.
   a) Enter **Get ServiceNow Fields (Dynamic)** for the **Name**.
   b) Click **Submit**.

9. Under **Action Outline**, click **Inputs**.
   a) Click **Create Input**.
   b) Enter **Table** for the **Label** and **Name**.
   c) Select **String** as the **Type**.
   d) Toggle the **Mandatory** slider so that it is active.

10. Under **Action Outline**, click the **Add a new step** icon under **Inputs** and select the **REST** step. Enter the following information.

<table>
<thead>
<tr>
<th>Input</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Leave Use Connection Alias selected</td>
</tr>
<tr>
<td>Connection Alias</td>
<td><img src="image" alt="Create new record" /> icon to create a new HTTP(s) connection, or use an existing connection for your instance. The Credential for the HTTP(s) connection must use basic auth. Additionally, the Connection URL must be the base URL for your instance, including the forward slash at the end.</td>
</tr>
<tr>
<td>Build Request</td>
<td>Leave Manually selected</td>
</tr>
<tr>
<td>Resource Path</td>
<td>Enter api/now/table/ and then click the data pill picker ( ), Select Inputs &gt; Table.</td>
</tr>
<tr>
<td>HTTP Method</td>
<td>Enter GET</td>
</tr>
</tbody>
</table>

11. Under **Action Outline**, click the **Add a new step** icon under your REST step and select the **Script** step.
   a) In the **Input Variables** section, click **Create Variable**.
   b) Enter **payload** as the **Name**.
   c) For the **Value**, click the data pill picker ( ) and select **REST Step > Response Body**.
   d) Enter the following code for the **Script**.

```
```
(function execute(inputs, outputs) {
    var payload = JSON.parse(inputs.payload);
    var fields = Object.keys(payload.result[0]).
        map(function(property) {
            return {
                label: property.charAt(0).toUpperCase() +
                property.slice(1).replace(/\_/g, ' '),
                name: property,
                value: '' // value is always empty
            };
        });
    outputs.fields = { data: fields }; // final properly formatted output
})(inputs, outputs);

e) In the Output Variables section, click Create Variable.
f) Enter fields for the Label and Name.
g) Select JSON as the Type.

a) Click Create Output.
b) Enter output for the Label and Name.
c) Select JSON as the Type.
d) Click Exit Edit Mode.
e) For the Value, click the data pill picker () and select Script Step > fields.

13. Click Save and then test the action.
a) Enter incident for the Table input.
b) Click Run Test.
c) Check the action's execution details. Your data gathering action runs successfully if the runtime value for fields is a complex object containing an array of key-value pairs for label, name, and value as shown in the following abbreviated example.

```json
{
    "data": [
        {
            "name": "Parent",
            "label": "parent",
            "value": ""
        },
        {
            "name": "Made sla",
            "label": "made_sla",
            "value": ""
        },
        {
            "name": "Caused by",
            "label": "caused_by",
            "value": ""
        },
        {
            "name": "Watch list",
            "label": "watch_list",
            "value": ""
        }
    ]
}
```
14. Click **Publish** to make the Get ServiceNow Fields (Dynamic) action available to other actions within the Global scope.

15. Click the **Create flow, subflow, or action** icon and select **Action**.
   a) Enter Create ServiceNow Record (Dynamic) for the **Name**.
   b) Click **Submit**.

16. Under **Action Outline**, click **Inputs**.
   a) Click **Create Input**.
   b) Enter **Table** for the **Label** and **Name**.
   c) Select Dynamic Choice as the **Type**.
   d) Toggle the **Mandatory** slider so that it is active.
   e) Expand the **Advanced options**.
   f) Under **Dynamic Options**, select Get ServiceNow Tables (Dynamic) as the **Action**.
   g) Click **Create Input** to create another action input.
   h) Enter **Fields** for the **Label** and **Name**.
   i) Select Dynamic Template as the **Type**.
   j) Toggle the **Mandatory** slider so that it is active.
   k) Expand the **Advanced options**.
   l) Under **Dynamic Options**, select Get ServiceNow Fields (Dynamic) as the **Action**.
   m) Toggle the **Depends-On Another Input** slider to make it active.
   n) Select **Table** for the **Table** input.

17. Under **Action Outline**, click the **Add a new step** icon under **Inputs** and select the **Script** step.
   a) In the **Input Variables** section, click **Create Variable**.
   b) Enter **table** as the **Name**.
   c) For the **Value**, click the data pill picker and select **Inputs > Table**.
   d) Click **Create Variable** to create another input variable.
   e) Enter **fields** as the **Name and String**.
   f) For the **Value**, click the data pill picker and select **Inputs > Fields**.
   g) Enter the following code for the **Script**.

```javascript
(function execute(inputs, outputs) {
  var now_GR = new GlideRecord(inputs.table);
  gr.applyEncodedQuery(inputs.fields);
  gr.insert();
})(inputs, outputs);
```
18. Click **Save** and then test the action.
   a) Select any dynamically-generated choice value for the Table input.
   b) Click **Add Field Value**. Then, select a field and enter any value.
   c) Click **Run Test**.
   d) Check the action’s execution details. Your action runs successfully if the runtime values for Table and Field match the values you entered for the test.

19. Click **Publish** to make the Create ServiceNow Record (Dynamic) action available to flows within the Global scope.

You can now add the Create ServiceNow Record (Dynamic) action to a flow in Flow Designer. This sample action dynamically generates a list of tables and associated fields in your instance whose values you can assign during flow design.
Create a data gathering action for a dynamic choice

Create an action to collect input values to pass to a parent action as a dynamic choice.

Role required: action_designer or admin

1. Navigate to Flow Designer > Designer.
2. Click the New button and select New Action.
3. Enter a Name for your action and choose the proper Application scope. Then, click Submit.
4. Under Action Outline, click the Add a new step icon under Inputs and select the REST step. Configure your REST step to get data from the proper Base URL and Resource Path with any applicable Query Parameters for the HTTP Method GET. For more information on using the REST step in IntegrationHub, see REST step and REST in IntegrationHub.
5. Under Action Outline, click the Add a new step icon under your REST step and select the Script step. This script step must transform the REST step’s Response Body into a format that can be used as a dynamic choice for a parent action. Format the JSON output variable so that it contains a property named data with a structure similar to the following example.

```
{
    data: [
        {
            label: "Choice Option 1",
            name: "choice_option_1"
        },
        {
            label: "Choice Option 2",
            name: "choice_option_2"
        },
        {
            label: "Choice Option 3",
            name: "choice_option_3"
        }
    ]
}
```

6. Under Action Outline, click Outputs. Create an output named output of type JSON. Then, use the data pill picker to assign the data pill for the JSON output variable from your script step to the action output’s Value.

**Note:** The action can have multiple outputs, but there can only be one of type JSON.

7. Click Save and test the action. In the execution details, your data gathering action runs successfully if the runtime value for output contains the data property in the proper format.
8. Click Publish to make the action available to other flows and actions within the same application scope.
You can now use your data gathering action to populate the options that appear for a dynamic choice input in a parent action.

Create a data gathering action for a dynamic template

Create an action to collect input values to pass to a parent action as a dynamic template.

Role required: action_designer or admin

1. Navigate to Flow Designer > Designer.
2. Click the New button and select New Action.
3. Enter a Name for your action and choose the proper Application scope. Then, click Submit.
4. Under **Action Outline**, click the **Add a new** step icon under **Inputs** and select the REST step. Configure your REST step to get data from the proper **Base URL** and **Resource Path** with any applicable **Query Parameters** for the **HTTP Method GET**. For more information on using the REST step in IntegrationHub, see **REST step** and **REST in IntegrationHub**.

5. Under **Action Outline**, click the **Add a new step** icon under your REST step and select the **Script** step. This script step must transform the REST step's **Response Body** into a format that can be used as a dynamic choice for a parent action. Format the JSON output variable so that it contains a property named **data** with a structure similar to the following example.

   ```json
   {
     data: [
       {
         label: "Template Option 1",
         name: "template_option_1",
         value: ""
       },
       {
         label: "Template Option 2",
         name: "template_option_2"
       },
       {
         label: "Template Option 3",
         name: "template_option_3",
         value: "",
         type: "choice",
         choices: [
           { label: "Choice 1", value: "choice_1" },
           { label: "Choice 2", value: "choice_2" }
         ]
       }
     ]
   }
   ```

   **Note:** The JSON output structure for a dynamic template can include the optional properties **type** and **choices**.

   - **type**: Specify a valid field type to render the appropriate UI control for the dynamic template.
   - **choices**: If specifying **choice** for the **type** property, you can then specify an array of choice options that will render in a list for the dynamic template.

6. Under **Action Outline**, click **Outputs**. Create an output named **output** of type JSON. Then, use the data pill picker icon to assign the data pill for the JSON output variable from your script step to the action output's **Value**.

   **Note:** The action can have multiple outputs, but there can only be one of type JSON.

7. Click **Save** and **test the action**. In the execution details, your data gathering action runs successfully if the runtime value for **output** contains the **data** property in the proper format.

8. Click **Publish** to make the action available to other flows or actions within the same application scope.
You can now use your data gathering action to populate the options that appear for a dynamic template input in a parent action.

Dynamic input configuration options

Use these options to configure your dynamic inputs for a parent action.

Dynamic input configuration

Dynamic input options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a label that will appear for the action input when the action is added to a flow.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the dynamic choice or template.</td>
</tr>
<tr>
<td>Max length</td>
<td>Enter the maximum character length for one choice or template field value.</td>
</tr>
<tr>
<td>Hint</td>
<td>Enter a hint to display for the dynamic input.</td>
</tr>
<tr>
<td>Choice</td>
<td>Select from</td>
</tr>
<tr>
<td></td>
<td>• Dropdown with --None--</td>
</tr>
<tr>
<td></td>
<td>• Dropdown without --None--</td>
</tr>
<tr>
<td>Default Value</td>
<td>Enter a string value to use as a default for the dynamic input.</td>
</tr>
<tr>
<td>Action</td>
<td>Select a data gathering action that generates values as JSON output.</td>
</tr>
<tr>
<td>Depends-on Another Input</td>
<td>Enable this option to require an input value from the parent action to be passed as an input to the data gathering action. If enabled, select a dependent input from the parent action.</td>
</tr>
</tbody>
</table>

### Create an action

Create a reusable component to automate one or more steps of a process.

- Set up an application in Guided Application Creator to store Flow Designer content.
- Role required: flow_designer, action_designer or admin

Action designers should know the application table structure and be aware of any existing business logic associated with the target tables of an action. Be sure to disable any conflicting business rules or workflows before creating an action.

Creating a custom application to contain your Flow Designer content enables you to deploy it using the application repository or the ServiceNow Store.

1. Navigate to Flow Designer > Designer.
2. Click the Actions tab and select New Action.
3. Fill in the Action Properties and click **Submit**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the input. This value is used as the name of the data pill in the right-hand pane.</td>
</tr>
</tbody>
</table>

**Note:** Action input names can't include any of the following reserved system names:
- `sys_id`
- `sys_created_by`
- `sys_created_on`
- `sys_updated_on`
- `sys_updated_by`
- `sys_mod_count`

<table>
<thead>
<tr>
<th>Accessible From</th>
<th>Accessible from all application scoped or only within the specified application scope.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Defined category within the application scope for an action.</td>
</tr>
<tr>
<td>Protection</td>
<td>Select whether the action is read-only. You can only select a value when you create the action in an application scope you own. The default value is None.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the action.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the action.</td>
</tr>
<tr>
<td>In-Flow Annotation</td>
<td>Help text that appears under the action title in Flow Designer to help flow designers understand what the action does when used in a flow.</td>
</tr>
</tbody>
</table>

An empty action opens.

4. Define action inputs to make data available to the action steps and outputs.

a) Select `+ Create Input` and complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the input. This value is used as the name of the data pill in the right-hand pane.</td>
</tr>
</tbody>
</table>

**Note:** Action input names can't include any of the following reserved system names:
- `sys_id`
- `sys_created_by`
- `sys_created_on`
- `sys_updated_on`
- `sys_updated_by`
- `sys_mod_count`

| Type   | Data type of the input. For supported data types, see Action input and output data types. |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Table</td>
<td>Reference table for the data type. Only required for the following data types:</td>
</tr>
</tbody>
</table>
|             | • Conditions  
|             | • Document ID  
|             | • Records  
|             | • Reference  
|             | • Template Value |

### Advanced options

Inputs provide advanced options based on their data type. All inputs have advanced options to add a hint or provide a default value. Use advanced options to guide flow designers through adding and configuring an action to a flow. For example, create a choice input to provide flow designers with a pre-defined list of configuration options to choose from. For more information about the configuration options available to particular data types, see field types.

Click ![view advanced options](image) to view the advanced options and define values.

Inputs are represented as data pills in the right-hand pane. You can add inputs to steps and outputs in the flow by dragging and dropping data pills.

5. Add an action step to perform an operation on the action inputs.
   a) Click the + underneath Inputs in the Action Outline.
   b) Select the step you would like to perform.
   c) Complete the fields in the step.

6. Add action outputs to make data available to a flow.
   a) Select + Create Outputs and complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the output. This value is the name of the data pill in the right-hand pane when the action is added to a flow.</td>
</tr>
</tbody>
</table>

**Note:** Action output names can't include any of the following reserved system names:

- sys_id
- sys_created_by
- sys_created_on
- sys_updated_on
- sys_updated_by
- sys_mod_count

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Data used previously in the action either in a step or input. Adding a variable to the output makes the value available to the flow.</td>
</tr>
</tbody>
</table>

7. Click **Save**. Action Designer saves a draft of the action.
Test the action until it is ready to be published.

Note: By default, the system only runs published actions.

Test an action

Test an action before publishing it for other users.

• Create an action and save it.
• Role required: flow_designer, flow_operator, action_designer, or admin.

Flow designers should always test actions on non-production instances containing relevant demonstration data since testing an action creates or changes records on the instance.

1. Navigate to Flow Designer > Designer.
2. Click the Actions tab and select the action you want to test.
3. Click Test.
   The system displays the Test Action dialog. The Test Action dialog contains all the inputs.
4. Provide the inputs for the action.

   Note: Inputs must be provided for all the mandatory fields.

5. Click Run Test.

Click Action has been executed. To view the action, click here to view the action execution details. See Flow execution details for information about the executions.

   Note: Users must have the flow_operator or admin role to view the executions.

Ask for Approval step

Request approval for a record with an approval field. You can configure a rule set for an approval, rejection, or cancellation. If a due date is added to an approval, the approval is automatically approved, rejected, or canceled if the approvers have not responded by the designated time.

Approvals is a platform feature that enables users or groups to approve or reject a task.

Roles and availability

• Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Select a record under the data panell and drag the record pill into the Record field. If selecting a table with an approval field already configured, the Approval field is set to the correct field.</td>
</tr>
<tr>
<td>Table</td>
<td>Set to the table name associated with the record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Approval field</td>
<td>Select a field from the designated table to use for approval.</td>
</tr>
<tr>
<td>Journal field</td>
<td>Select a field from the designated table to use for journal.</td>
</tr>
</tbody>
</table>

**Rules**

Define the approval and rejection rules. Approval rules determine which users can approve or reject requests, and what happens after approval or rejection. Approval or rejection rules include:

- Anyone approves
- All users approve
- All responded and anyone approves
- % of users approve
- # of users approve

In the field beside the approval rule, add the desired approvers. To add approvers:

- Select individual users or groups.
- Drag-and-drop or select a field from a record.

Select to allow a manual approver to process an approval or rejection. A manual approver is a user manually added to the Approvers related list who can then approve the request. For example, you can manually add a subject matter expert to a task to approve the request. To learn more about adding manual approvers, see Generate approvals using the approvers related list.

Define rejection rules by adding another OR rule set. When defining approvals, include rejection rules that run when there are no matching approvals. Such rejection rules prevent the flow from remaining in a waiting state. For example, if an approval can be approved by anyone, create a time-based rejection rule in case no one approves it.

**Note:** If you set an approval rule with no rejection rule (or vice versa) and the expected approval state is not met, the runtime value will be canceled.

**Due Date**

Define a due date to ensure that the flow does not remain in a waiting state if the request is not approved or denied.

- None: The approval is not dependent on a specific date.
- Approve: Automatically approve the step if an action is still pending by the specified date.
- Reject: Automatically reject the step if an action is still pending by the specified date.
- Cancel: Automatically cancel the step if an action is still pending by the specified date.
Example

1. Ask for Approval step

Approval Request Definition

- **Record**: action INCIDENT
- **Table**: Incident [incident]
- **Approval Field**: Approval
- **Journal Field**: Approval history

**Rules**

- **Approve**: When:
  - Anyone approves

- **Reject**: When:
  - Anyone rejects

**Due Date**

- Approve if pending by Relative date 1 Days From action INCIDENT

Days schedule: 8-5 weekdays excluding holidays

Output

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval State</td>
<td>State of the approval request</td>
<td>Choice</td>
</tr>
</tbody>
</table>

Create Record step

Creates a record on any table. You can dynamically add and configure fields for the record.

Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.
Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table from the list.</td>
</tr>
<tr>
<td>Field Values</td>
<td>Set static or dynamic values of fields in the record. For example, to set the short description to a static value, select <strong>Short description</strong> and set the desired value. To add dynamic values, see <strong>Allow flow designers to dynamically set field values</strong>.</td>
</tr>
</tbody>
</table>

Create or Update Record step

Create or update a record in a ServiceNow table by determining if it already exists. Add records that do not exist, and update existing ones. Identify existing records by selecting unique fields. Set field values dynamically and enforce server-side validation rules (data policy, business rules, dictionary-defined mandatory fields). UI policy does not apply.

Roles and availability

Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>Table in which a record is created or updated.</td>
</tr>
<tr>
<td>Fields</td>
<td>Values of fields in the record to be created or updated.</td>
</tr>
<tr>
<td></td>
<td>If adding the action to a subflow, you can <strong>Allow flow designers to dynamically set field values</strong>. Dynamically set field values can trigger server-side validation rules such as data policies, business rules, and dictionary-defined mandatory fields, but cannot trigger UI policies.</td>
</tr>
<tr>
<td>Determines uniqueness</td>
<td>Option for selecting the field as a unique identifier. This field appears when the required table name and fields are selected.</td>
</tr>
</tbody>
</table>

Create Task step

Create a task on any ServiceNow task table. After you choose the task table, you can dynamically select the fields to configure the action. Defining the Parent field associates the task to a parent record.
Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a task table.</td>
</tr>
<tr>
<td></td>
<td>- Catalog Task [sc_task]</td>
</tr>
<tr>
<td></td>
<td>- Change Phase [change_phase]</td>
</tr>
<tr>
<td></td>
<td>- Change Request [change_request]</td>
</tr>
<tr>
<td></td>
<td>- Chat Queue Entry [chat_queue_entry]</td>
</tr>
<tr>
<td></td>
<td>- Feature Task [release_task]</td>
</tr>
<tr>
<td></td>
<td>- Follow On Task [cert_follow_on_task]</td>
</tr>
<tr>
<td></td>
<td>- Group approval [sysapproval_group]</td>
</tr>
<tr>
<td></td>
<td>- Guided Setup Task [gsw_task]</td>
</tr>
<tr>
<td></td>
<td>- IMAC [change_request_imac]</td>
</tr>
<tr>
<td></td>
<td>- Incident [incident]</td>
</tr>
<tr>
<td></td>
<td>- Incident Task [incident_task]</td>
</tr>
<tr>
<td></td>
<td>- KB Submission [kb_submission]</td>
</tr>
<tr>
<td></td>
<td>- Orphan CI Remediation [orphan_ci_remediation]</td>
</tr>
<tr>
<td></td>
<td>- Private Task [vtb_task]</td>
</tr>
<tr>
<td></td>
<td>- Problem [problem]</td>
</tr>
<tr>
<td></td>
<td>- Problem Task [problem_task]</td>
</tr>
<tr>
<td></td>
<td>- Reclassification Task [reclassification_task]</td>
</tr>
<tr>
<td></td>
<td>- Recommended Field Remediation [recommended_field_remediation]</td>
</tr>
<tr>
<td></td>
<td>- Remediate Duplicate Task [reconcile_duplicate_task]</td>
</tr>
<tr>
<td></td>
<td>- Release Phase [release_phase]</td>
</tr>
<tr>
<td></td>
<td>- Renew Lease Task [statemgmt_renew_lease_task]</td>
</tr>
<tr>
<td></td>
<td>- Request [sc_request]</td>
</tr>
<tr>
<td></td>
<td>- Request new Knowledge Base</td>
</tr>
<tr>
<td></td>
<td>- [kb_knowledge_base_request]</td>
</tr>
<tr>
<td></td>
<td>- Requested Item [sc_req_item]</td>
</tr>
<tr>
<td></td>
<td>- Required Field Remediation [required_field_remediation]</td>
</tr>
<tr>
<td></td>
<td>- Security Case [sn_ti_case]</td>
</tr>
<tr>
<td></td>
<td>- Security Incident [sn_si_incident]</td>
</tr>
<tr>
<td></td>
<td>- Security Incident Response Task [sn_si_task]</td>
</tr>
<tr>
<td></td>
<td>- Security Request [sn_si_scan_request]</td>
</tr>
<tr>
<td></td>
<td>- Service Order [sm_order]</td>
</tr>
<tr>
<td></td>
<td>- Service Order Task [sm_task]</td>
</tr>
<tr>
<td></td>
<td>- Service Task [service_task]</td>
</tr>
<tr>
<td></td>
<td>- Stale CI Remediation [stale_ci_remediation]</td>
</tr>
<tr>
<td></td>
<td>- Standard Change Proposal [std_change_proposal]</td>
</tr>
<tr>
<td></td>
<td>- Ticket [ticket]</td>
</tr>
</tbody>
</table>
### Field Values
Set static or dynamic values of fields in the record. For example, to set the short description to a static value, select **Short description** and set the desired value. To add dynamic values, see Allow flow designers to dynamically set field values. To associate the task with a parent record, define the **Parent** field.

### Wait
Waits to complete the step until the task completes and is no longer active (active=false). Alternatively, you can add a wait condition by dragging-and-dropping a true/false field from the data panel into the **Wait** field. The flow only waits for the task to complete when the condition field is true.

### Delete Record step
Deletes a record on any table.

**Roles and availability**

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>The record to be deleted. Drag-and-drop a record data pill or use the data pill picker to select a record.</td>
</tr>
<tr>
<td>Table</td>
<td>Read-only. Set to the table associated with the record.</td>
</tr>
</tbody>
</table>

### Log step
Logs a message in the Flow Designer log table.

**Roles and availability**

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.
Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log level</td>
<td>Level of importance of the log message.</td>
</tr>
<tr>
<td></td>
<td>• Error</td>
</tr>
<tr>
<td></td>
<td>• Warn</td>
</tr>
<tr>
<td></td>
<td>• Info</td>
</tr>
<tr>
<td>Log message</td>
<td>Message to display in the log. Enter text or drag-and-drop data pills into the field.</td>
</tr>
</tbody>
</table>

Look Up Record step

Look up a record from any table based on defined conditions.

Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table from the list.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Set static or dynamic conditions to filter records. To define a static condition applied each time the action runs, define the conditions with the condition builder. To enable flow designers to dynamically apply conditions, define an input of type Conditions and drag-and-drop the input data pill into the Conditions field. When building a condition that looks up the value of a reference field, use a data pill that explicitly provides the Sys ID value. Ensure the condition has the format [reference field][is][Reference type data pill-&gt;Sys ID]. For example, both the Change and Incident tables contain a reference field to the User table. To look up change records where the requester is the caller from an incident record, create the condition [Requested by][is][action-&gt;incident-&gt;Caller-&gt;Sys ID] where incident is an input variable for an incident record.</td>
</tr>
<tr>
<td>Order by</td>
<td>Determines how to sort results when more than one record matches the defined conditions. Select the field you want to use to sort results.</td>
</tr>
<tr>
<td>Sort Type</td>
<td>Select whether to sort alphabetically in ascending or descending order.</td>
</tr>
<tr>
<td>If multiple records are found</td>
<td>Determines what is returned if more than one record matches the defined conditions.</td>
</tr>
<tr>
<td></td>
<td>• Return only the first record</td>
</tr>
<tr>
<td></td>
<td>• Fail the step</td>
</tr>
</tbody>
</table>
Example

### Look Up Record step

<table>
<thead>
<tr>
<th>Table</th>
<th>Incident [incident]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td></td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>is</td>
</tr>
<tr>
<td><strong>State</strong></td>
<td>is</td>
</tr>
<tr>
<td><strong>Short description</strong></td>
<td>is</td>
</tr>
<tr>
<td><strong>AND</strong></td>
<td></td>
</tr>
<tr>
<td><strong>New</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Email</strong></td>
<td></td>
</tr>
<tr>
<td>or</td>
<td></td>
</tr>
<tr>
<td><strong>New Criteria</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Order by</strong></td>
<td>Short description</td>
</tr>
<tr>
<td><strong>Sort Type</strong></td>
<td>a to z</td>
</tr>
<tr>
<td><strong>If multiple records are found</strong></td>
<td>Return only the first record</td>
</tr>
</tbody>
</table>

**Look Up Records step**

Look up multiple records on any table using defined conditions.

**Roles and availability**

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table from the list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Conditions</td>
<td>Set static or dynamic conditions to filter records. To define a static condition applied each time the action runs, define the conditions with the condition builder. To enable flow designers to dynamically apply conditions, define an input of type Conditions and drag-and-drop the input data pill into the Conditions field. When building a condition that looks up the value of a reference field, use a data pill that explicitly provides the Sys ID value. Ensure the condition has the format [reference field][is][Reference type data pill-&gt;Sys ID]. For example, both the Change and Incident tables contain a reference field to the User table. To look up change records where the requester is the caller from an incident record, create the condition [Requested by][is][action-&gt;incident-&gt;Caller-&gt;Sys ID] where incident is an input variable for an incident record.</td>
</tr>
<tr>
<td>Order by</td>
<td>Select the field you want to use to sort results.</td>
</tr>
<tr>
<td>Sort Type</td>
<td>Select whether to sort alphabetically in ascending or descending order.</td>
</tr>
<tr>
<td>Max Results</td>
<td>Maximum number of results returned.</td>
</tr>
</tbody>
</table>

Example

1. Look Up Records step

Table  | Incident [incident]                                                                 |
Conditions  | All of these conditions must be met                                                                                                           |
          |  | Assigned to  | is | Bow Ruggeri  |  |
          |  | AND | State | is | New  |
          |  | or |  |  | New Criteria |  |
Order by | Short description                                                                                                                       |
Sort Type | a to z                                                                                                                                           |
Max Results | 1000                                                                                                                                          |
Notification step

Trigger a notification as a step within an action by selecting a record (such as an incident, change request, problem, or user record) to trigger a notification and defining the associated notification.

Notifications is a platform feature. Before triggering a notification as an action step in Flow Designer, ensure that the notification is set up for use in the platform.

- When you create or update the notification, set the Send when field in the When to send tab of the Notification form to Triggered.
- Verify that your users have an active primary email channel and that all their notifications are active.

Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Drag-and-drop an input record or a record from a previous step. This is the record that will trigger a notification.</td>
</tr>
<tr>
<td>Note: Some notifications are not associated with a specific record or table, such as the Passwords Require Updating notification. If configuring such a notification, leave this field blank.</td>
<td></td>
</tr>
<tr>
<td>Table name</td>
<td>Read-only. Set to the table of the triggering record.</td>
</tr>
<tr>
<td>Notification</td>
<td>Select the notification to be triggered. The notifications that can be selected are associated with the table of the specified record. If no record was selected, you can select a notification that does not have an associated record or table. To create notifications, see Create an email notification.</td>
</tr>
</tbody>
</table>

Example

1. Notification step

<table>
<thead>
<tr>
<th>Record</th>
<th>action→incident</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>Incident [incident]</td>
</tr>
<tr>
<td>Notification</td>
<td>Incident Priority Raised</td>
</tr>
</tbody>
</table>
Payload Builder step
Enable action designers to easily create name-value pairs in JSON and XML payloads using dynamic data.

Roles and availability

• Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name Value Pairs| The name-value pairs to include in the payload. Click the plus icon to add name-value pairs. Drag data pills into either field to produce dynamic payloads. The Name becomes a key in JSON and an element in XML. For example, suppose you create this name-value pair.  
  • Name: short_description  
  • Value:[action]->[short_description]  
  When the system formats the name-value pair as JSON:  
  "short_description": "[action]->[short_description]"  
  When the system formats the name-value pair as XML:  
| Omit if empty   | The option to exclude a name-value pair if the value is empty or null.  
  Note: This field is only visible after clicking the down arrow to display advanced options. |
| Output Format   | The payload file format.  
  • JSON: Select to format the payload as a JSON document.  
  • XML: Select to format the payload as an XML document. |
<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Namespace</td>
<td>The XML namespace to apply to each element. For example, when the namespace is set to <code>incident:</code>&lt;br&gt;&lt;br&gt;<code>xml&lt;br&gt;&amp;lt;incident:short_description&amp;gt;[action]-&amp;gt;[short_description]&amp;lt;/incident:short_description&amp;gt;&lt;/xml&gt;</code>&lt;br&gt;&lt;br&gt;Note: This field is only visible when the <strong>Output Format</strong> is set to XML.</td>
</tr>
<tr>
<td>Include Outer Structure</td>
<td>The option to include or exclude a top level container appropriate to the output format. When the <strong>Output Format</strong> is JSON, curly braces contain the name-value pairs. When the <strong>Output Format</strong> is XML, a specified XML element contains the name-value pairs.&lt;br&gt;&lt;br&gt;For example, when the system formats the name-value pair as JSON:&lt;br&gt;&lt;br&gt;<code>{&lt;br&gt;&amp;quot;short_description&quot; : &amp;quot;[action]-&amp;gt;[short_description]&quot;&lt;br&gt;&amp;}&lt;br&gt;</code>&lt;br&gt;&lt;br&gt;When the system formats the name-value pair as XML:&lt;br&gt;&lt;br&gt;<code>&lt;xml&gt;&lt;br&gt;&amp;lt;short_description&amp;gt;[action]-&amp;gt;[short_description]&amp;lt;/short_description&amp;gt;&lt;br&gt;&amp;&lt;/xml&gt;</code></td>
</tr>
<tr>
<td>Send Empty Structure</td>
<td>The option to send valid JSON or XML structures when the payload is empty. Enable this option to include JSON or XML structural text in the payload.&lt;br&gt;&lt;br&gt;For example, when the system formats an empty structure as JSON:&lt;br&gt;&lt;br&gt;<code>{&lt;br&gt;&amp;}&lt;br&gt;</code>&lt;br&gt;&lt;br&gt;When the system formats an empty structure as XML:&lt;br&gt;&lt;br&gt;<code>&lt;xml&gt;&lt;/xml&gt;</code>&lt;br&gt;&lt;br&gt;Disable this option to produce an empty payload. Empty payloads can occur when you select the <strong>Omit if empty</strong> option for every name-value pair, and all name-value pairs in the payload produce empty values.</td>
</tr>
</tbody>
</table>
### ServiceNow® Now Platform capabilities

#### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Node</td>
<td>The name of the XML element that contains the name-value pairs. The default parent node element is <code>xml</code>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when the Output Format is set to XML and the option to Include Outer Structure is enabled.</td>
</tr>
<tr>
<td>Preview</td>
<td>The read-only payload the step produces.</td>
</tr>
</tbody>
</table>

### PowerShell step

Run PowerShell scripts on remote machines from your ServiceNow instance through a MID Server.

PowerShell is built on the Windows .NET Framework and is designed to control and automate the administration of Windows machines and applications. ServiceNow supports PowerShell 2.0 and above. PowerShell 3.0 does not support Windows 2003 Server.

**Note:** PowerShell step is not available in the base system and requires the ServiceNow® IntegrationHub subscription. After the required plugin is activated, the step is visible under Integrations.

### Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Define Connection Inline:</strong> Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias:</strong> Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Connection Alias** | Connection & Credential alias record the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane.  

**Note:** This field is only visible when the **Connection** is **Use Connection Alias**.                                                                                                                                                                                                                                                                                                                                                                                              |
| **Credential Alias** | Credential alias the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane.  

**Note:** This field is only visible when the **Connection** is **Define Connection Inline**.                                                                                                                                                                                                                                                                                                                                                                                             |
| **Host**       | Specify the fully-qualified domain name of the target host where the system runs the action step. For example, host.domain.com.  

**Note:** This field is only visible when the **Connection** is **Define Connection Inline**.                                                                                                                                                                                                                                                                                                                                                                                             |
| **Port**       | Specify the communications port on which the target host listens for connections. For example, 5985. Leave blank to use the default port.  

**Note:** This field is only visible when the **Connection** is **Define Connection Inline**.                                                                                                                                                                                                                                                                                                                                                                                             |
| **MID Application** | Specify the application the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected application. If you use a data pill for this field, the pill must reference the MID Application's name, not the MID Application record.  

**Note:** This field is only visible when the **Connection** is **Define Connection Inline**.                                                                                                                                                                                                                                                                                                                                                                                             |
| **Capabilities** | Specify the capabilities the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected capabilities.  

**Note:** This field is only visible when the **Connection** is **Define Connection Inline**.                                                                                                                                                                                                                                                                                                                                                                                             |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remoting Type</td>
<td>The location where the PowerShell script runs such as the MID or a remote server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Explicit Remoting (Most Common)</strong>: Establish a connection with and run the script on a remote server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Implicit Remoting (Advanced)</strong>: Run a script on a MID Server while importing necessary modules from a remote server. If selected, define the <strong>Remote name prefix</strong> and <strong>Modules to import</strong> fields. For optimal performance, only import modules necessary to the step. If blank, all available modules are imported from the server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Run on a MID Server or have your script establish a remote session</strong>: Run a script directly on a MID Server, or define remoting specifications within the script. This value is the default.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: To invoke a function in a PowerShell script command or PowerShell script file, the command must define the function param block if the function has input parameters. This requirement applies to explicit and implicit remoting. For additional information on param block, see Microsoft's documentation on Windows Powershell parameters at <a href="https://technet.microsoft.com/">https://technet.microsoft.com/</a>.</td>
</tr>
<tr>
<td>Remote name prefix</td>
<td>The file path, excluding file names, to the modules to load from the remote server.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when the <strong>Remoting Type</strong> is <strong>Implicit Remoting (Advanced)</strong>*.</td>
</tr>
<tr>
<td>Modules to import</td>
<td>The comma-separated list of modules to import from the remote server at the defined file path.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when the <strong>Remoting Type</strong> is <strong>Explicit Remoting (Most Common)</strong> or <strong>Implicit Remoting (Advanced)</strong>.</td>
</tr>
<tr>
<td>Script type</td>
<td>The type of script to run on the PowerShell host.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Inline script</strong>: Enter the script to run in the <strong>Command</strong> field of the step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>MID Server Script File</strong>: Select the PowerShell script to run from the MID Server Script Files [ecc_agent_script_file] table. This is the default value and separates scripting logic from the action, enabling you to update the script without having to modify and redeploy the action.</td>
</tr>
<tr>
<td>MID Server Script</td>
<td>Pre-defined PowerShell script from the MID Server Script Files table [ecc_agent_script_file].</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only available if the <strong>Script type</strong> is <strong>MID Server Script File</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Script path</td>
<td>Read-only path to the selected MID Server script.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when the <strong>Script type</strong> is MID Server</td>
</tr>
<tr>
<td></td>
<td><strong>Script File.</strong></td>
</tr>
<tr>
<td>Input variables</td>
<td>The optional name-value pairs that represent the values of PowerShell script</td>
</tr>
<tr>
<td></td>
<td>variables. You can use action inputs and data from other steps within the</td>
</tr>
<tr>
<td></td>
<td>PowerShell script. Define the following fields for each variable:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Name:</strong> The name of the script variable to pass a value to. The name</td>
</tr>
<tr>
<td></td>
<td>cannot match a reserved or prohibited PowerShell variable. Some variable</td>
</tr>
<tr>
<td></td>
<td>names are reserved for internal processing and should not be used as input</td>
</tr>
<tr>
<td></td>
<td>variables. See <strong>Reserved variables</strong> in <strong>PowerShell scripting variables</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> The type of PowerShell variable. Select plain text, encrypted, or</td>
</tr>
<tr>
<td></td>
<td>boolean. If encrypted is selected, the value appears in plain text in this</td>
</tr>
<tr>
<td></td>
<td>field and is only encrypted when it passes to the ECC Queue.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Value:</strong> The value to map to the variable. Manually enter a value, or</td>
</tr>
<tr>
<td></td>
<td>drag a data pill into the field.</td>
</tr>
<tr>
<td>Command</td>
<td>The inline PowerShell script to run on the target host.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when the <strong>Script type</strong> is Inline script.</td>
</tr>
</tbody>
</table>

**PowerShell scripting variables**

To access input variables from the **Command** field, you must call them using special syntax. The syntax you use depends on the value of a system property. If the **Remoting Type** is **Run on a MID Server** or **have your script establish a remote session**, some reserved variables are available in addition to input variables.

**Input variable syntax**

By default, prefix variable names with a $ character. For example, if an input variable is named **message**, use $message to access the variable in script.

If the **mid.powershell.command.script.parameter_passing** parameter is set to false, prefix the variable name with $env:SNC_. For example, if an input variable is named **message**, use $env:SNC_message to access the variable in script. To learn more about the **mid.powershell.command.script.parameter_passing** parameter, see **MID Server parameters**.

**Reserved variables**

When the **Remoting Type** is **Run on a MID Server** or **have your script establish a remote session**, the following variables are available for use in script. Reserved variables cannot be used as custom input variable names.

<table>
<thead>
<tr>
<th>Reserved variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$computer</td>
<td>Host IP address defined in the Connection alias record.</td>
</tr>
<tr>
<td>$cred</td>
<td>Credential object that contains the credentials defined in the connection record. Use this variable with any PowerShell cmdlet that supports the credential parameter. For example, <strong>New-PSSession -credential $cred.</strong></td>
</tr>
</tbody>
</table>
Reserved variable | Description
--- | ---
$log\_info$ | If the `mid.property.powershell.log_info` property is set to true, adds logging information to a PowerShell script.

The following variable names are reserved for internal processing and should not be used as input variables.

- script
- useCred
- isMid
- isDiscovery
- debug
- user
- password
- executingScriptDirectory
- midScriptDirectory
- hresult

REST step

Send an outbound REST web service request to an external system.

**Note:** REST step is not available in the base system and requires the ServiceNow® IntegrationHub subscription. After the required plugin is activated, the step is visible under Integrations.

Outbound REST web service is a platform feature that allows you to retrieve, create, update, or delete data on a web services server that supports the REST architecture.

Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Connection | The type of connection to use.  
  - **Define Connection Inline:** Define connection information within the action step.  
  - **Use Connection Alias:** Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. |

To learn more about connections and credentials, see credentials, connections, and aliases.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Alias</strong></td>
<td>Connection &amp; Credential alias record the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane.</td>
</tr>
<tr>
<td><strong>Credential Alias</strong></td>
<td>Credential alias the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane.</td>
</tr>
<tr>
<td><strong>Use MID</strong></td>
<td>The option to use a MID Server to run the REST step. Select this option to display the MID Application and Capabilities fields.</td>
</tr>
<tr>
<td><strong>Base URL</strong></td>
<td>The base URL for the REST request. If Use Connection Alias is selected, this field is read-only and displays the base URL associated with alias. If Define Connection Inline is selected, enter a base URL for the connection.</td>
</tr>
<tr>
<td><strong>MID Application</strong></td>
<td>Specify the capabilities the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected capabilities.</td>
</tr>
<tr>
<td><strong>Capabilities</strong></td>
<td>Specify the capabilities the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected capabilities.</td>
</tr>
<tr>
<td><strong>Build Request</strong></td>
<td>Create the request manually, or import an OpenAPI Specification.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Manually</strong>: Create action inputs and complete the REST step form manually.</td>
</tr>
<tr>
<td></td>
<td>• <strong>From OpenAPI specification</strong>: Import an OpenAPI Specification to generate action inputs and complete the REST step form. For more information, see OpenAPI support in the REST step.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>API Source</td>
<td>Select an OpenAPI Specification used to construct the request, or select Import OpenAPI to import a new OpenAPI Specification. You can import specifications by providing a URL to the YAML or JSON, or copying and pasting content.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when Build Request is set to From OpenAPI specification.</td>
</tr>
<tr>
<td>API Operation</td>
<td>Select an operation from the list. Available operations are provided by the OpenAPI Specification in the API Source field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when Build Request is set to From OpenAPI specification.</td>
</tr>
<tr>
<td>Resource Path</td>
<td>Specify the path for the resource.</td>
</tr>
<tr>
<td>HTTP Method</td>
<td>Specify the HTTP method to process the request.</td>
</tr>
<tr>
<td></td>
<td>• GET</td>
</tr>
<tr>
<td></td>
<td>• POST</td>
</tr>
<tr>
<td></td>
<td>• PUT</td>
</tr>
<tr>
<td></td>
<td>• PATCH</td>
</tr>
<tr>
<td></td>
<td>• DELETE</td>
</tr>
<tr>
<td>Query Parameters</td>
<td>Specify the name-value pairs to pass to the REST endpoint. You can create these parameters manually, or drag input variables into the parameter fields, and then assign a value.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When importing an OpenAPI Specification, the system adds all parameters and headers present in the specification to the REST step. Review the final REST step values and remove parameters you do not want to send in the request. For example, if the API accepts content type headers for both JSON and XML, the system adds both headers to the REST step. You must remove one depending on the content type you want to receive in the response.</td>
</tr>
<tr>
<td>Headers</td>
<td>Specify the headers to send with the request. You can create headers manually, or drag input variables into the parameter fields, and then assign a value.</td>
</tr>
</tbody>
</table>
|              | **Note:** When importing an OpenAPI Specification, the system adds all parameters and headers present in the specification to the REST step. Review the final REST step values and remove parameters you do not want to send in the request. For example, if the API accepts content type headers for both JSON and XML, the system adds both headers to the REST step. You must remove one depending on the content type you want to receive in the response.                                                                 ...........................................
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request Type</td>
<td>Specify the format of the request. Options include.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Text</strong>: A request in JSON, XML, or other text format.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Binary</strong>: A request in a binary file format.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Multipart</strong>: A request consisting of multiple content types.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Form URL-Encoded</strong>: A request in a URL-encoded query.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only editable when the <strong>HTTP Method</strong> is POST, PUT, PUT, PATCH, or DELETE.</td>
</tr>
<tr>
<td>Request Body [Text]</td>
<td>Enter the body of the request in JSON or XML format. The flow execution</td>
</tr>
<tr>
<td></td>
<td>details display the response body as either a link to the embedded text</td>
</tr>
<tr>
<td></td>
<td>viewer or the Sys ID of the attachment record containing the response.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only editable when the <strong>Request Type</strong> is Text.</td>
</tr>
<tr>
<td>Attachment</td>
<td>Specify the Attachment record containing the request. You can look up this</td>
</tr>
<tr>
<td></td>
<td>record in a prior step or define it as an input variable.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when the <strong>Request Type</strong> is Binary.</td>
</tr>
<tr>
<td>Name, Type, Value</td>
<td>Specify the content of a multiple part request. For each request part,</td>
</tr>
<tr>
<td></td>
<td>specify its name, content type, and value. The name can be any valid</td>
</tr>
<tr>
<td></td>
<td>string and the type can be any valid type. The value must match the</td>
</tr>
<tr>
<td></td>
<td>content type.</td>
</tr>
<tr>
<td></td>
<td>For attachments, specify:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: attachment</td>
</tr>
<tr>
<td></td>
<td>• <strong>Value</strong>: The Sys ID of the Attachment record containing the content.</td>
</tr>
<tr>
<td></td>
<td>You can look up this record in a prior step or define it as an input</td>
</tr>
<tr>
<td></td>
<td>variable.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: These fields are only visible when the <strong>Request Type</strong> is</td>
</tr>
<tr>
<td></td>
<td><strong>Multipart</strong>.</td>
</tr>
<tr>
<td>Name, Value</td>
<td>Specify the content of a form URL-encoded request. Specify each part of</td>
</tr>
<tr>
<td></td>
<td>the URL-encoded request with a name-value pair.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: These fields are only visible when the <strong>Request Type</strong> is Form</td>
</tr>
<tr>
<td></td>
<td><strong>URL-Encoded</strong>.</td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to enable the retry policy. For more information, see Retry policy.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This option is not applicable when <strong>Define Connection Inline</strong> is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with <strong>Connection Alias</strong>. If <strong>Override Default Policy for Alias</strong> is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
</tbody>
</table>
### REST response size limits

By default, the system limits the size of REST responses that are not saved as attachments to 5 MB. Direct REST responses that exceed this limit generate an error. To support larger response sizes, either save the response as an attachment or increase the response size limit with the `glide.pf.rest.response_payload_max_size` system property. This system property supports a maximum value of 10 MB.

### Script step

Add custom JavaScript to execute within a reusable action. While most core actions and steps fit common use cases, you can build a Script step to execute behavior not satisfied by the core steps.

### Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.
- The Script step is available by default to run JavaScript on a local instance.

**Note:** An IntegrationHub subscription is required to enable integration features such as running a Script step on a MID Server. See Request IntegrationHub for information about IntegrationHub usage and subscriptions.

### Fields

The JavaScript step includes separate input and output variables that enable you to map JavaScript data to Flow Designer data. By defining input and output variables within the step, you can define what Flow Designer data is available within your script, and which scripting variables are available to other steps in your action.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required Runtime</td>
<td>The runtime environment required to support the script. Choices include:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Instance</strong>: The action step runs the script from instance. Select this option when the script needs access to the ServiceNow API or instance data. This is the default value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>MID</strong>: The action step runs the script from the MID Server. Select this option when the script needs access to MID Server script files and APIs. Selecting this option displays the <strong>Select MID Server Using</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Vanilla (Core JavaScript)</strong>: The action step runs the script from either the instance or MID Server. Select this option when the script only needs the core JavaScript APIs and not the ServiceNow API or instance data.</td>
</tr>
<tr>
<td></td>
<td>The runtime you select determines the JavaScript objects and methods displayed in the <strong>Context-sensitive help</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when IntegrationHub is activated.</td>
</tr>
<tr>
<td>Select MID Server Using</td>
<td>Specify the MID Server selection process to use. Choices include:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Any MID</strong>: The system runs the action step from any available MID Server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias</strong>: The system runs the action using the connection alias you specify. Selecting this option displays the <strong>Connection Alias</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Inline Selection</strong>: The system runs the action using the connection details you specify in the action. Selecting this option displays the <strong>Host</strong>, <strong>MID Application</strong>, and <strong>Capabilities</strong> fields.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when IntegrationHub is activated, and you select <strong>MID</strong> from <strong>Required Runtime</strong>.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see <a href="#">credentials, connections, and aliases</a>. Only aliases of connection type Basic are supported.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when IntegrationHub is activated, and you select <strong>Use Connection Alias</strong> from <strong>Select MID Server Using</strong>.</td>
</tr>
<tr>
<td>Host</td>
<td>The fully-qualified domain name of the MID Server where the system runs the action step. For example, mid-server.domain.com.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when IntegrationHub is activated, and you select <strong>Use Inline Selection</strong> from <strong>Select MID Server Using</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MID Application</td>
<td>Specify the application the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected application.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Specify the capabilities the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected capabilities.</td>
</tr>
<tr>
<td>Input variables</td>
<td>Name-value pairs that represent data from the action, enabling you to use action inputs and data from other steps within a script.</td>
</tr>
<tr>
<td>Script</td>
<td>Script that executes within the action. To access input and output variables in your script, use the global objects inputs and outputs. For example, inputs.myVariable.</td>
</tr>
<tr>
<td>Output variables</td>
<td>Map JavaScript output to Flow Designer data pills. Define output variables when you want other steps in the action to use the script output.</td>
</tr>
</tbody>
</table>

**Example**

This example builds a JSON payload that can be easily updated or changed and added to a subsequent REST step.
By creating an output variable that represents the payload, you can drag the [Payload] data pill into the REST step Body field.

**Send Email step**

Send an email to specified users or groups as an action in a flow.

**Roles and availability**

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.
### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Record</td>
<td>Record that the email is associated to. When a user sends a reply to your email, the target record is updated with the reply email content.</td>
</tr>
<tr>
<td>Table</td>
<td>Table of the target record.</td>
</tr>
<tr>
<td>Include Watermark</td>
<td>Option to apply a watermark to the email that is sent. To include a watermark, you must set a target record.</td>
</tr>
<tr>
<td>To</td>
<td>The main recipients of the email. Enter a list of user email addresses separated by commas or white spaces. You can also drag-and-drop data pills that contain email addresses into the field, such as a User record. For example, if your action involves an incident record and you want to send an email to the group assigned to the incident, drag the [Assignment group] data pill from the data panel.</td>
</tr>
<tr>
<td>CC</td>
<td>Additional recipients copied on this email. Enter a list of user email addresses separated by commas or white spaces. You can also drag-and-drop data pills that contain email addresses into the field.</td>
</tr>
<tr>
<td>BCC</td>
<td>Additional recipients of this email, who are visible only to the sender (blind copied). Enter a list of user email addresses separated by commas or white spaces. You can also drag-and-drop data pills that contain email addresses into the field.</td>
</tr>
<tr>
<td>Subject</td>
<td>Subject of the email. You can enter text or drag-and-drop data pills into the field.</td>
</tr>
<tr>
<td>Body</td>
<td>The content of the message body. You can enter text or drag-and-drop data pills into the field.</td>
</tr>
</tbody>
</table>

**Note:** Flow Designer does not support the ${URI} parameter for creating a link to a record in the email message body. Instead, consider inserting the information from the record in the email body using data pills, or create a notification step.

### Testing the email step

To verify that the email was generated when testing the action, review the email record in the Email [sys_email] table. The **Headers** field indicates whether the email was successfully generated. For example:

```
X-ServiceNow-Source: FlowDesigner-9ad2747b0b710300f4eb8bf637673a1e
Message-ID:<193756824.0.1508534586438@[10.0.66.70]>
X-ServiceNow-Generated:true
```

ACL restrictions apply to the Send Email action. If you configured your flow to run as the user who initiates the session, ensure that the user has access control to send email. To test access controls for a Send Email action, impersonate a typical email sender and manually trigger the flow.
SSH step

The SSH step executes SSH commands on an external *nix system through a ServiceNow® MID Server. The step also stores scripts and commands for the *nix systems.

Note:
- The SSH step is not available in the base system. The step requires the subscription to ServiceNow® IntegrationHub and activation of IntegrationHub Professional Pack Installer (com.glide.hub.integrations.professional) or later. For more information about the IntegrationHub subscription packages, see IntegrationHub usage and subscription. After you activate the required plugin, the step is visible under Integrations.
- IntegrationHub supports ServiceNow SSH only.

Roles and availability

The SSH step is available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Sanitizing arguments using the escape class and function

Escape all user inputs to eliminate the possibility of a malicious user executing arbitrary commands on your target server. Escape and validate data pills before the command field uses them by sanitizing arguments using a preprocessing Script step. Precede the SSH step with a Script step, which takes the arguments that are used to construct a command in the SSH step.

In the Script step, use the escape class, GlideShellEscapeUtils and escape function, escapeBashShellArg. The escaped arguments are the output of the Script step. Use this escaped output as the arguments of the commands used in the SSH step. The escaped values should contain arguments of a command.

Escape APIs

<table>
<thead>
<tr>
<th>Escape class/function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlideShellEscapeUtils</td>
<td>Provides scripted APIs to escape the shell arguments. For example, var escapedArgument = SNC.GlideShellEscapeUtils.escapeBashShellArg('/etc &amp;&amp; cat myfile.txt'); The escaped argument is, '/etc &amp;&amp; cat myfile.txt'.</td>
</tr>
</tbody>
</table>
| escapeBashShellArg    | • Adds single quotes around a string.  
                          • Escapes any existing single quotes within a string enabling you to pass the string directly to a shell function and treat the string as a single safe argument. |
# Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Details</strong></td>
<td></td>
</tr>
</tbody>
</table>
| **Connection**         | Type of connection to use.  
  - **Define Connection Inline**: Define connection information within the action step.  
  - **Use Connection Alias**: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.  
  To learn more about connections and credentials, see credentials, connections, and aliases. |
<p>| <strong>Connection Alias</strong>   | Connection &amp; Credential alias record the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane. This field is available when <strong>Use Connection Alias</strong> is selected from the Connection list. |
| <strong>Credential Alias</strong>   | Credential alias the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list. |
| <strong>Host</strong>               | Host name or IP address of the target server. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Application</td>
<td>Option to use a MID Server to run the SSH step. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. Select <strong>SSH</strong>. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list.</td>
</tr>
<tr>
<td><strong>SSH Configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Working Directory</td>
<td>Optional target directory on the target host where the command is run.</td>
</tr>
<tr>
<td>Command</td>
<td>Command that runs on the target directory. The command can also include MID Serverscripts. See <strong>Advanced SSH script options</strong> for more information.</td>
</tr>
<tr>
<td><strong>Note:</strong> Escape and validate data pills before the command field uses them by sanitizing arguments using a preprocessing Script step. For more information, see Sanitizing arguments using the escape class and function.</td>
<td></td>
</tr>
<tr>
<td>Long Running</td>
<td>Option to disable the SSH connection timeout for commands that might take longer than the default time of 120 seconds to run. When selected, the engine detaches from the execution thread until completion.</td>
</tr>
<tr>
<td>Sudo Mode</td>
<td>Option to elevate privileges to execute the script.</td>
</tr>
</tbody>
</table>

For more information, see **SSH credentials**.

**Advanced SSH script options**

To run a MID Server script on the target host, specify the script type and pass the name of the script into the `${syncFile()}` parameter. The system uses this parameter to locate the named script in the MID Server Script File `[ecc_agent_script_file]` table and run it on the target host. For example, a bash script can be expressed as:

```bash
bash ${syncFile("<MID script name>")} argument1 argument2 argument3
```

A base script (`main_script.bash`) can reference another script (`my_include.bash`) as well as a separate file (`.my_profile`) located on the target host. Both scripts and the file referenced must be synced to the MID Server, using the `${syncFile()}` parameter, to execute properly.

```bash
source ${syncFile(".my_profile")}
cp ${syncFile("my_include.bash")} /usr/ssmith/my_include.bash
bash ${syncFile("main_script.bash")} one two three four five six
rm /usr/ssmith/my_include.bash
```

A Python example with inline comments might look like this:

```python
set $LIB_DIR=/usr/bin;
# Sync a file that is referenced inside myF5CreateLBPool.py
```
ServiceNow    DocVersion    Now Platform  capabilities

```
cp ${syncFile("specialFunctions.py")} ~/specialFunctions.py
# set up environment variables
source ${syncFile(".python_profile")}
# call script that sets up dependencies on the box from remote package repos
python ${syncFile("setupPythonDependencies.py")} pycontrol
# call a script that requires functions from the package as well as a function from myIncludedFile
python ${syncFile("myF5CreateLBPool.py")} snow_pool myActualValue
# user is responsible for their own cleanup
rm ~/specialFunctions.py
```

To see the list of available MID Server scripts, navigate to MID Server > Script Files.

**JDBC step**

Create a reusable action to send SQL commands to a relational database.

**Note:**
- The JDBC step is not available in the base system and requires the subscription to IntegrationHub Standard Pack Installer (com.glide.hub.integrations.standard) or later. For more information about the ServiceNow®IntegrationHub subscription packages, see IntegrationHub usage and subscription. After the required plugin is activated, the step is visible under Integrations.
- The JDBC step runs only on a ServiceNow® MID Server with JDBC step capabilities. Activate the plugin, IntegrationHub Standard Pack Installer (com.glide.hub.integrations.standard) or later to use the JDBC capability for the MID Server.

**Roles and availability**

The JDBC step is available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

**Sanitizing inputs using the escape functions**

Escape all user inputs to eliminate the possibility of a malicious user from executing malicious SQL statements, resulting in SQL injection on your target database. When you use data pills in JDBC step SQL statements, sanitize them first using a preprocessing Script step.

In the Script step, use the escape APIs, `escapeSQLIdentifier` and `escapeSQLValue`. These APIs are available as static methods of the server-side script class, `SNC.GlideSQLEscapeUtils`. For example,

```
var escapedValue = SNC.GlideSQLEscapeUtils.escapeSQLValue("MYSQL", "Georgi's Birthday");
```

The escaped values from the escape APIs are the output of the Script step. Use this escaped output in the SQL statements of the JDBC step.
## Escape APIs

<table>
<thead>
<tr>
<th>Escape API</th>
<th>Description</th>
</tr>
</thead>
</table>
| escapeSQLIdentifier| • Escapes special characters and injected values in the SQL identifiers.  
                        • Validates input for a period character. Throws an SQLEscapeException error when a period character is encountered. |
| escapeSQLValue     | Escapes special characters and injected values in SQL values by wrapping the input in database-specific quotes.                                |

**Note:** To join SQL identifiers using a period, use two pills, which are ID escaped, joined by the period.

## Whitelisting SQL operations

By default, you can run the following SQL operations.

- SELECT
- INSERT
- UPDATE
- DELETE
- SHOW
- DESCRIBE

To enable only some of these SQL operations that the JDBC step can perform, create a MID Server property, `mid.property.jdbc_operations` and enter the whitelisted SQL operations, separated by comma. To learn more about MID Server properties, see [MID Server properties](#).

## Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Details</td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td>Connection</td>
<td>• <strong>Define Connection Inline:</strong> Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias:</strong> Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don’t need to update your custom action.</td>
</tr>
</tbody>
</table>

To learn more about connections and credentials, see [credentials, connections, and aliases](#).
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane. This field is available when Use Connection Alias is selected from the Connection list.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
</tbody>
</table>
| Database Type       | Database type for this connection. The choices are:  
|                     | • MySQL  
|                     | • Oracle  
|                     | • SQLServer  
|                     | • Custom  
|                     | The default choice is Custom. This field is available when Define Connection Inline is selected from the Connection list. |
| JDBC Driver         | Driver to use for this connection when it's not a default database type such as DB2 Universal and Sybase. The database Type is Custom. This field is available when Define Connection Inline is selected from the Connection list and Custom is selected from the Database Type list. |
| Connection URL      | URL that the MID Server uses to connect to the specified database. The URL is created automatically when you save the form, and is read-only for the default databases. This field is available when Define Connection Inline is selected from the Connection list and Custom is selected from the Database Type list. |
| MID Application     | Application that the MID Server must support to be eligible for selection. This field is available when Define Connection Inline is selected from the Connection list. |
| Capabilities        | Capability of the MID Server. Select JDBC. This field is available when Define Connection Inline is selected from the Connection list. |
| Connection Timeout  | Maximum elapsed time, in seconds, for the activity to wait while attempting to connect to the target database. This field is available when Define Connection Inline is selected from the Connection list. |
| Query Timeout       | Maximum elapsed time, in seconds, that the query is allowed to run without a response. This field is available when Define Connection Inline is selected from the Connection list. |
| JDBC Configuration  |
### Field | Description
---|---
SQL Statement | SQL statement that the step executes.  
**Note:** When you use data pills in step SQL statements, sanitize them first using a preprocessing Script step. For more information, see Sanitizing inputs using the escape functions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Rows</td>
<td>Maximum number of rows to be returned from the SQL statement. The default value is <strong>1000</strong>.</td>
</tr>
<tr>
<td>Maximum Payload Size (KB)</td>
<td>Maximum allowable payload size, in KB, to be returned from the SQL statement. The default payload size is <strong>5120 KB</strong>. The maximum payload size is <strong>5 MB</strong>.</td>
</tr>
</tbody>
</table>

### Test JDBC step

Test the JDBC step before testing or publishing an action that contains the JDBC step.

It is mandatory that you test the JDBC step before testing the action. Testing ensures that the relevant complex object output schema is created from table columns, which can be used as data pills in subsequent steps.

1. Navigate to **Flow Designer > Designer**.
2. Create an action with a JDBC step.
3. Click **Test JDBC Step**. The **Test JDBC Step** pop-up window is displayed.
4. If the JDBC step takes an action input or output of the previous step as its input, provide required input values in the **Step input pills** field to test the JDBC step.

**Note:** Input values in the **Step input pills** fields are not needed when records are updated, inserted, or deleted.

5. Click **Run Test**.
   - When a SELECT query is executed, **Sample Result** is displayed in the **Test JDBC Step** pop-up window. **Sample Result** includes column names, columns types, and the values of the first row.
   - When an UPDATE, INSERT, or DELETE query is executed, a message is displayed mentioning the number of rows affected.

6. To use the sample result as the JDBC step output, click **Use Result**.

**Note:** **Use Result** is not displayed when records are updated, inserted, or deleted.

7. To retrieve schema of a different table when a SELECT query is executed in the JDBC step, enter the required value in the **Step input pills** field and click **Run Test**.
When a SELECT query is executed in the JDBC step, ResultSet is displayed under Outputs. The relevant complex object output is populated. To learn more about complex objects, see Complex data.

Test and publish the action.

**SOAP step**

Enable action designers to send outbound SOAP web service requests to external systems.

**Note:** SOAP step is not available in the base system and requires the ServiceNow® IntegrationHub subscription. After the required plugin is activated, the step is visible under Integrations.

**Roles and availability**

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.
- Action designers need the web_service_admin role to perform these web services tasks.
  - Select WSDL
  - Load new WSDL
  - Select a WS-Security policy
- The MID Server does not support WS-Security policies

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Details</strong></td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td>The type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Define Connection Inline:</strong> Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Use Connection Alias:</strong> Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane. <strong>Note:</strong> This field is only visible when the Connection is Use Connection Alias.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane. <strong>Note:</strong> This field is only visible when the Connection is Define Connection Inline.</td>
</tr>
<tr>
<td>Use MID</td>
<td>The option to use a MID Server to run the SOAP step. Select this option to display the MID Application and Capabilities fields.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>The URL endpoint for the SOAP request. If Use Connection Alias is selected, this field is read-only and displays the endpoint URL associated with alias. If Define Connection Inline is selected, enter a endpoint URL for the connection.</td>
</tr>
<tr>
<td>Request Details</td>
<td>The method to use when building the SOAP envelope.</td>
</tr>
<tr>
<td>Build Envelope</td>
<td>• From WSDL: Select this option to display the Select a WSDL and Operation fields.</td>
</tr>
<tr>
<td></td>
<td>• Manually: Select this option to manually enter or paste WSDL text.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Select a WSDL</td>
<td>The WSDL to use to build the SOAP envelope. Select an existing WSDL record or click <strong>Load New WSDL</strong> to download or manually enter a WSDL file. The selected WSDL populates the values of the <strong>Operation</strong>, <strong>SOAP action</strong>, and <strong>SOAP Envelope</strong> fields.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when <strong>Build Envelope</strong> is set to <strong>From WSDL</strong>.</td>
</tr>
<tr>
<td>Load New WSDL</td>
<td>The option to download or manually enter a WSDL file.</td>
</tr>
<tr>
<td>Operation</td>
<td>The operation to run from the selected WSDL. Each WSDL has its own list of available operations.</td>
</tr>
<tr>
<td>SOAP Action</td>
<td>The URL to run the SOAP action. If <strong>Build Envelope</strong> is set to <strong>From WSDL</strong>, this field is read-only and displays the URL to run SOAP action. If <strong>Build Envelope</strong> is set to <strong>Manually</strong>, enter a URL to run the SOAP action.</td>
</tr>
<tr>
<td>SOAP Envelope</td>
<td>The XML text sent to the endpoint. If <strong>Build Envelope</strong> is set to <strong>From WSDL</strong>, the system adds the necessary XML for the <strong>Operation</strong> you select. If <strong>Build Envelope</strong> is set to <strong>Manually</strong>, enter the XML text you want to use. Enter record values in the appropriate SOAP envelope elements. For example, enter an incident short description in the <code>&lt;short_description&gt;</code> element.</td>
</tr>
<tr>
<td>Reset Envelope</td>
<td>The option to discard all manual changes you made to the SOAP envelope. Select this option to revert the SOAP envelope to its original state.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option is only active when <strong>Build Envelope</strong> is set to <strong>From WSDL</strong>.</td>
</tr>
<tr>
<td>New WSDL</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>The name of WSDL record you want to create.</td>
</tr>
<tr>
<td>Import Method</td>
<td>The method to enter WSDL.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Download from URL:</strong> Select to display the WSDL URL, <strong>User name</strong>, and <strong>Password</strong> fields to retrieve the WSDL from an external source, typically the web service provider.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Manually Populate WSDL Content:</strong> Select to display the <strong>WSDL Content</strong> field to manually enter or paste WSDL text.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>WSDL URL</td>
<td>The URL to the SOAP web service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when the Import Method is set to Download from URL.</td>
</tr>
<tr>
<td>User name</td>
<td>The user name to authenticate with the SOAP web service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when the Import Method is set to Download from URL.</td>
</tr>
<tr>
<td>Password</td>
<td>The password to authenticate with the SOAP web service. The system always masks passwords in the user interface and prevents exporting them as plain text.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when the Import Method is set to Download from URL.</td>
</tr>
<tr>
<td>WSDL Content</td>
<td>The XML document describing the SOAP web service and its operations.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when the Import Method is set to Manually Populate WSDL Content.</td>
</tr>
<tr>
<td>Import</td>
<td>The option to add the SOAP web service WSDL to the instance.</td>
</tr>
<tr>
<td>WS-Security</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable WS-Security Policy</td>
<td>The option to restrict the SOAP web service to a security policy. Select to display the Policy field.</td>
</tr>
<tr>
<td>Policy</td>
<td>The policy record you want to use to restrict web service connections. Select an existing policy record.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to enable the retry policy. For more information, see Retry policy.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This option is not applicable when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Headers</td>
<td>The name-value pairs to include in the SOAP message as HTTP headers. Click the plus icon to add headers. Add a <strong>Name</strong> and <strong>Value</strong> for each HTTP header.</td>
</tr>
<tr>
<td>Omit if empty</td>
<td>The option to exclude a name-value pair if the value is empty or null.</td>
</tr>
</tbody>
</table>

**Note:** This field is only visible after clicking the down arrow to display advanced options.

**SOAP response size limit**

The system limits the size of SOAP responses to 5 MB. Direct SOAP responses that exceed this limit generate an error. To support larger response sizes, increase the response size limit with the `glide.pf.soap.response_payload_max_size` system property. This system property supports a maximum value of 10 MB.

**Update Record step**

Update an existing record in a table. You can dynamically add and configure fields for the record, or use a template to set field values.

**Roles and availability**

- Available as an Action Designer action step. Users with the `action_designer` role can create a custom action with one or more action steps.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>The record to be updated. Drag-and-drop a record data pill or use the data pill picker to select a record.</td>
</tr>
<tr>
<td>Table</td>
<td>Read-only. Set to the table associated with the record.</td>
</tr>
<tr>
<td>Field Values</td>
<td>Set static or dynamic values of fields in the record. For example, to set the short description to a static value, select <strong>Short description</strong> and set the desired value. To add dynamic values, see <strong>Allow flow designers to dynamically set field values</strong>.</td>
</tr>
</tbody>
</table>

**Wait For Condition step**

Pause a flow until record values match a specific set of conditions.
Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Drag-and-drop an input record or a record from a previous step.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If this record is deleted while the flow is waiting, the flow stops waiting and continues running.</td>
</tr>
<tr>
<td>Table</td>
<td>Read-only. Set to the table associated with the record.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions that the flow waits for. Example: if the condition is [State][is][Closed], the flow pauses until the condition is met. Once met, the flow moves on to the next step or action. Set static or dynamic conditions to filter records. To define a static condition applied each time the action runs, define the conditions with the condition builder. To enable flow designers to dynamically apply conditions, define an input of type Conditions and drag-and-drop the input data pill into the Conditions field.</td>
</tr>
</tbody>
</table>

Unsupported tables

The system does not support Wait for Condition for the following tables.

<table>
<thead>
<tr>
<th>Table Category</th>
<th>Table Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit</td>
<td>Sys Audit [sys_audit], Audit Deleted Record [sys_audit_delete], Audit Relationship Change [sys_audit_relation], Audit Roles [sys_audit_role], Audit Relationship Change [sys_audit_relation], Audit Deleted Record [sys_audit_delete]</td>
</tr>
<tr>
<td>Email</td>
<td>Email [sys_email], Email Account [sys_email_account], Email Log [sys_email_log]</td>
</tr>
<tr>
<td>Events</td>
<td>Event [sysevent], Notification [sysevent_email_action], Stationery [sysevent_email_style], Email Template [sysevent_email_template], Inbound Email Actions [sysevent_in_email_action], Slow Event [sysevent_pattern], Event Registration [sysevent_registration], Script Action [sysevent_script_action]</td>
</tr>
<tr>
<td>Table Category</td>
<td>Table Names</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Import Sets</td>
<td>Import Set [sys_import_set], Import Set Row [sys_import_set_row], Import Set Row Error [sys_import_set_row_error], Transform History [sys_import_set_run], Computer [imp_computer], Notification [imp_notification], Location [imp_location], User [imp_user]</td>
</tr>
<tr>
<td>JRobin</td>
<td>JRobin Database [jrobin_database], JRobin Shard [jrobin_shard], Graph Line [jrobin_graph_line], JRobin Shard Fragments [jrobin_shard_location], Member [jrobin_graph_set_member], Round Robin Archive [jrobin_archive], Round Robin DataSource [jrobin_data_source], Round Robin Definition [jrobin_definition], Round Robin Graph [jrobin_graph], Round Robin Graph Set [jrobin_graph_set]</td>
</tr>
<tr>
<td>Logs</td>
<td>Log Entry [syslog], Service Portal Log Entry [sp_log]</td>
</tr>
<tr>
<td>MID Server</td>
<td>MID Server Property [ecc_agent_property], Mid Server Log [ecc_agent_log], Queue [ecc_queue], Configuration [ecc_queue_config], ECC Queue Statistics (by ECC Agent) [ecc_queue_stats_by_ecc_agent]</td>
</tr>
<tr>
<td>Performance Analytics</td>
<td>Job Log [pa_job_logs]</td>
</tr>
<tr>
<td>Record Watcher</td>
<td>Responders [sys_rw_action], Channel Responders [sys_rw_amb_action]</td>
</tr>
<tr>
<td>Reporting</td>
<td>Summary Set [sys_report_summary], Report Summary Line [sys_report_summary_line]</td>
</tr>
<tr>
<td>Scheduled Jobs</td>
<td>Schedule Item [sys_trigger], Broadcast Message [sys_broadcast_message], Broadcast Message Relationships [sys_broadcast_message_m2m], Progress Worker [sys_progress_worker], Progress Worker Domain [sys_progress_worker_domain]</td>
</tr>
<tr>
<td>SSO</td>
<td>SSO Properties [sso_properties], Digest Token Properties [digest_properties], SAML Update 1 Properties [saml2_update1_properties], SSO Federation [sso_federation]</td>
</tr>
<tr>
<td>System Cache</td>
<td>Cache Flush [sys_cache_flush], Cache Entry [sys_db_cache]</td>
</tr>
<tr>
<td>System Clone</td>
<td>ServiceNow Instance [instance], Clone Security Token [clone_token], Preserved Data [clone_preserved_data]</td>
</tr>
<tr>
<td>System Dictionary</td>
<td>Dictionary Entry Override [sys_dictionary_override]</td>
</tr>
<tr>
<td>System Events</td>
<td>Event Processor [sys_event_processor]</td>
</tr>
<tr>
<td>System Fields</td>
<td>Field Class [sys.glide_object]</td>
</tr>
<tr>
<td>System Performance</td>
<td>Component Status [sys_status], Cluster Message [sys_cluster_message], Node State [sys_cluster_state]</td>
</tr>
<tr>
<td>Table Category</td>
<td>Table Names</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Text Index</td>
<td>Ts Attachment [ts_attachment], Text Index Attribute Map [ts_attribute_map],</td>
</tr>
<tr>
<td></td>
<td>Ts Chain [ts_chain], Chain Summary [ts_chain_summary], Text Index Column</td>
</tr>
<tr>
<td></td>
<td>Attribute Map [ts_column_attribute_map], Text Index Configuration [ts</td>
</tr>
<tr>
<td></td>
<td>configuration], Text Index Configuration Attribute [ts_configuration_attribute],</td>
</tr>
<tr>
<td></td>
<td>Ts Delete Doc [ts_deleted_doc], Ts Document [ts_document], Ts Field [ts_field],</td>
</tr>
<tr>
<td></td>
<td>Text Search Groups [ts_group], Japanese User Token [ts_japanese_token_dictionary],</td>
</tr>
<tr>
<td></td>
<td>Ts Phrase [ts_phrase], Global Searches [ts_query], Knowledge Searches [ts</td>
</tr>
<tr>
<td></td>
<td>query_kb], Text Search Stat [ts_search_stats], Text Search Summaries [ts</td>
</tr>
<tr>
<td></td>
<td>search_summary], Stop Word [ts_stop], Synonym Dictionary [ts_synonym_dictionary],</td>
</tr>
<tr>
<td></td>
<td>Synonym Set [ts_synonym_set], Text Search Table [ts_table], Text Index Table</td>
</tr>
<tr>
<td></td>
<td>Attribute Map [ts_table_attribute_map], Service Catalog Searches [sc_ts_query],</td>
</tr>
<tr>
<td></td>
<td>Ts Word [ts_word], Ts Word Roots [ts_word_roots]</td>
</tr>
<tr>
<td>Update Sets</td>
<td>Update Set [sys_update_set], Update Version [sys_update_version], Customer</td>
</tr>
<tr>
<td></td>
<td>Update [sys_update_xml], Update Set Log [sys_update_set_log]</td>
</tr>
<tr>
<td>Upgrades</td>
<td>System Upgrades [sys_upgrade_history], Upgrade Details [sys_upgrade_history_log], System Upgrade Metric [sys_upgrade_metric], Upgrade Blame Log [sys_upgrade_blame], Upgrade Manifest [sys_upgrade_manifest], Upgrade State [sys_upgrade_state]</td>
</tr>
<tr>
<td>Usage Analytics</td>
<td>Usage Data for Applications [ua_app_usage], UsageAnalytics Count Configurations [usageanalytics_count_cfg], Application Metadata [ua_app_metadata], UsageAnalytics Count for Tables [usageanalytics_count], Subscription [license_details], Role for Subscription [role_has_license]</td>
</tr>
<tr>
<td>Users</td>
<td>User Session [sys_user_session], User Token [sys_user_token], User Preference [sys_user_preference], Navigator History [sys_ui_navigator_history]</td>
</tr>
<tr>
<td>Workflow</td>
<td>Workflow Execution [wf_workflow_execution], Workflow History [wf_history], Workflow Executing Activity [wf_executing], Workflow Queued Command [wf_command], Workflow Context [wf_context], Workflow Transition History [wf_transition_history]</td>
</tr>
</tbody>
</table>
Domain separation and Flow Designer

Flow Designer supports domain separation of business logic, which lets each tenant domain have its own flows, actions, and subflows. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Support: Level 2

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

How domain separation works in Flow Designer

The system domain separates Flow Designer content according to these rules.

**Flow Designer content inherits the domain of the user who creates them**

Flows, actions, and subflows belong to the domain of the user who creates them. For example, when a Service Provider (SP) administrator in the TOP domain creates a flow, it belongs to the TOP domain.

**Note:** The domain selected from the domain picker overrides the domain the user belongs to. For example, when an SP administrator in the TOP domain selects the ACME domain from the domain picker, any content created belongs to the ACME domain.

**Flow Designer content runs from the domain from which it is triggered or initiated**

Flows, actions, and subflows run from the domain of the record or user who initiates them. For example, when a user from the child domain ACME triggers a flow belonging to the parent domain TOP, the flow runs in the context of the child domain ACME.
### Domain assignment by trigger type

<table>
<thead>
<tr>
<th>Trigger type</th>
<th>Domain assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>API call</td>
<td>Domain of the user making API call</td>
</tr>
<tr>
<td>Email trigger</td>
<td>Domain of the email sender</td>
</tr>
<tr>
<td>Record trigger</td>
<td>Domain of the triggering sender</td>
</tr>
<tr>
<td>Scheduled trigger</td>
<td>Domain of the flow</td>
</tr>
<tr>
<td>Service Catalog trigger</td>
<td>Domain of the requested item record</td>
</tr>
</tbody>
</table>

### Flow Designer only runs content accessible from the current domain context

The system can only run content to which the current domain context allows access. See Understanding domain separation to understand data separation and the domain hierarchy. For example, a user in the child domain ACME can trigger flows belonging to the parent domain TOP, but cannot trigger flows belonging to a sibling domain such as INITECH.

Flow Designer runs record operations from the current user domain context. A read operation such as the Lookup Records action returns records based on the currently selected domain and its children. For example, if the currently selected domain is the TOP domain, you will see records from the TOP domain and all its children such as the ACME and INITECH domains. If the currently selected domain is the ACME domain, you will see records from the ACME domain and its children, but you will not see records from the parent TOP domain.

**Note:** Record operations use the data or process separation rules applied to the table the record belongs to. For example, suppose you have process-separated the Business Rule table. If you add a business rule to the TOP domain, the business rule will be accessible to record operations in child domains such as the ACME domain because process separation allows access to records from parent domains.

Flows that call another application such as a decision table or workflow also run from the current user domain context.

### Flow Designer runs all flows whose trigger conditions are met

A flow in one domain cannot override or prevent a flow from another domain from running. Flow Designer runs any flow that is visible to the current user and whose trigger conditions have been met. For example, a flow belonging to the TOP domain that is triggered by the creation of an incident record runs anytime an incident is created, regardless of whether the incident is created in the ACME or INITECH child domains.

### Design considerations

Follow these design considerations when using domain separation with Flow Designer.

**Have a Service Provider (SP) administrator in the TOP domain author and manage tenant flows, actions, and subflows**

Since tenants cannot override Flow Designer content, an SP administrator from the TOP domain must author and manage them to ensure they run properly for all domains. While you can create domain-specific flows, be aware that users working from domains higher in the hierarchy may trigger multiple child domain flows. For example, a user working in the TOP domain can trigger flows in child domains such as ACME and INITECH.
Note: Flow authors can see only Flow Designer content available from their current domain and any parent domains in the hierarchy. Flow Designer does not display content visible from contains domains.

Provide a unique name for each flow, action, and subflow

Since all domains share the same Flow Designer content, have an SP administrator in the TOP domain uniquely name each flow, action, and subflow to ensure that a flow intended for one domain does not duplicate the name of a flow in another domain. For example, add the domain to the flow name such as Validate incidents - TOP, Validate incidents - ACME, and Validate incidents - INITECH.

Ensure flows and actions only contain artifacts available from the current or parent domains

Flow Designer prevents the activation of any flow containing artifacts unavailable to the current or parent domains. For example, if you create a domain-specific flow that belongs to the ACME domain, it cannot contain actions or subflows belonging to the sibling domain INITECH.

Edit Flow Designer content in the domain to which it belongs

While users in a parent domain can see flows, actions, and subflows in a child domain, they must edit them in the domain they belong to. For example, an administrator in the TOP domain can see flows from the ACME domain but must switch to the ACME domain to edit it.

User access to Flow Designer

Administrators can grant users access to Flow Designer by assigning delegated development permissions or directly assigning a user role.

Access by delegated development permissions

Administrators can grant users access to Flow Designer by creating an application and assigning users as developers with the Flow Designer delegated development permission. Delegated development allows administrators to control whether flow designers can access features normally restricted to admin users such as assigning user roles, creating access controls, or creating scripts. See Developer permissions.

Access by user roles

Administrators can also grant access to Flow Designer by directly assigning users the flow_designer user role, which includes the role to view flow execution details.

Warning: Directly granting a user the flow_designer role is equivalent to giving the user the admin role, because Flow Designer can run flows as the System user, which has access to all tables and all database operations.

Flow Designer roles

Grant users one or more Flow Designer roles to enable them to create flows and subflows, to see flow execution details, and to create actions.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### API access to Flow Designer

Application developers can access Flow Designer functionality through APIs for flows, subflows, and actions. Flow designers can enable individual flows, subflows, and actions to be client callable during design.

### Available Flow Designer APIs

Triggers flows, subflows, and actions using these APIs from server or client scripts.

#### Server side

**FlowAPI**: Trigger a flow, subflow, or action using synchronous or asynchronous methods, with or without execution details.

#### Client side

**GlideFlow**: Perform client-side interactions with actions, flows, and subflows. Flow designers must enable a flow, subflow, and action to be called from the client.

#### FlowAPI quick methods

Use quick methods in the FlowAPI class to run an action, flow, or subflow from a server-side script without creating execution details or other related records. Use these methods to increase the speed of high-volume processing in a production environment, and to improve performance by eliminating record-keeping overhead. Methods include:

- `executeActionQuick()`, `executeFlowQuick()`, `executeSubflowQuick()`: Run an action, flow, or subflow from a server-side script synchronously from the current user session.
- `startActionQuick()`, `startFlowQuick()`, `startSubflowQuick()`: Run an action, flow, or subflow from a server-side script asynchronously.

#### Client callable APIs

By default, the flows, subflows, and actions can only be called by the FlowAPI within a server script. Flow and action designers can make individual flows, subflows, or actions available to client calls by enabling the **Client callable** option during design.

---

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Run as support

Flows and subflows can run as either the system user or the user who initiates the session. Set this behavior from the flow properties. All API quick methods ignore the run as property, and always run as the system user.

Actions always run as the user who initiates the session.

Code snippets

Application developers can generate a JavaScript function that calls a specific flow, subflow, or action with the Code Snippet option. Use the code snippet in scripts such as business rules or the Scripts - Background module to call specific Flow Designer elements. The system only generates code snippets for published flows, subflows, and actions. Flow Designer elements in the draft or modified status do not generate code snippets.

Create code snippets for flows, sub-flows, and actions

Generate a code snippet to call a specific flow, subflow or action.

• Role required: flow_designer or admin
• Activate the flow or subflow you want to call.
• Publish the action you want to call.

1. Navigate to Flow Designer > Designer.
2. Open a flow, subflow, or action.
3. Click the More Actions icon in the upper right corner of the flow designer.
5. A modal window appears containing the code snippet. The text of the snippet is selected by default. To copy the code, manually copy the code from the pop-up modal, or click the Copy Code Snippet Clipboard button.

Create a client callable flow, subflow, or action

Enable a client script to trigger a flow, subflow, or action.

• Role required: security_admin
• Consider the implications of making a flow, subflow, or action client callable, such as whether it exposes protected data or bypasses validation logic.

By default, the flows, subflows, and actions can only be called by the FlowAPI within a server script. Flow and action designers can make individual flows, subflows, or actions available to client calls by enabling the Client callable option during design.

1. Elevate privileges to security_admin.
3. Click New.
4. Create an access control.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>client_callable_flow_object</td>
</tr>
<tr>
<td>Operation</td>
<td>create</td>
</tr>
</tbody>
</table>
5. Assign the role to the user you would like to grant access to.
6. Enable a client script to trigger the flow, subflow, or action.
   a) Open the flow, subflow, or action you want to make client callable.
   b) In the More Actions menu, select Manage security.
   c) Select Callable by Client API.
   d) Add the access control record created earlier to the ACLs field.
   e) Click Update.

The user with the designated permissions can trigger a client callable flow, subflow, or action from a client script using the GlideFlow API.

Spokes

Add application-specific content to Flow Designer by installing spokes.

A spoke is a scoped application containing Flow Designer content dedicated to a particular application or record type. For example, the ITSM Spoke contains actions for managing Task records such as the Create Task action. Spokes are activated when their parent application is activated. For example, the ITSM Spoke is activated when the Incident, Problem, and Change applications are activated. Creating a spoke requires familiarity with application development as developers must add Flow Designer content to a scoped application.

Default spokes available

<table>
<thead>
<tr>
<th>Spoke</th>
<th>Description</th>
<th>Plugin</th>
<th>Included with</th>
</tr>
</thead>
<tbody>
<tr>
<td>Benchmarks Spoke</td>
<td>Provides read-only actions for the read-only Benchmark Recommendation Evaluator flow.</td>
<td>[com.sn_bm_client.spoke]</td>
<td>Benchmarks application.</td>
</tr>
<tr>
<td>Connect spoke</td>
<td>Provides actions to automate the creation of conversations, to add users to a conversation, and to send messages to a conversation. These actions work with Connect API version 3 and later.</td>
<td>[com.glide.connect_v3plus.core.ah]</td>
<td>Now Platform</td>
</tr>
<tr>
<td>Customer Service Spoke</td>
<td>Provides actions for flow designers to use when creating Customer Service Management business processes.</td>
<td>[com.snc.customer_service.spoke.e_946]</td>
<td>#unique_946 application</td>
</tr>
</tbody>
</table>
### Spokes

<table>
<thead>
<tr>
<th>Spoke</th>
<th>Description</th>
<th>Plugin</th>
<th>Included with</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Related Files</td>
<td>The External Related Files stores information about files in third-party systems and helps you manage the information.</td>
<td>[com.sn.external.files]</td>
<td>Now Platform</td>
</tr>
<tr>
<td>Field Service Spoke</td>
<td>Provides actions for flow designers to use when creating Field Service Management business processes.</td>
<td>[com.snc.field_service.spoke]</td>
<td>Field Service Management application</td>
</tr>
<tr>
<td>ITSM spoke</td>
<td>Provides flow and actions associated with ITSM. Requires the ITSM application suite.</td>
<td>[com.snc.itsm.spoke]</td>
<td>#unique_950 application</td>
</tr>
<tr>
<td>Visual Task Board (VTB) Spoke</td>
<td>Provides VTB actions for flow designers to manage the boards, lanes, cards, board members, and assignees.</td>
<td>[com.glide.ui.vtb.ah]</td>
<td>Now Platform</td>
</tr>
</tbody>
</table>

Additional spokes are available with an IntegrationHub subscription. To see a list of IntegrationHub spokes, see IntegrationHub available spokes. For more information about requesting an IntegrationHub subscription, see Request IntegrationHub.

### Benchmarks Spoke

Provides read-only actions for the read-only Benchmark Recommendation Evaluator flow.

The Benchmarks Spoke is designed for the Recommendations feature of the Benchmarks application.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Action Inputs</th>
<th>Action Outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Recommendation Activity Records</td>
<td>Create or update recommendation activity records.</td>
<td>• Recommendation</td>
<td>N/A</td>
</tr>
<tr>
<td>Delete Recommendation Evaluations</td>
<td>Delete recommendation evaluations for the specified month.</td>
<td>• Activity record</td>
<td>N/A</td>
</tr>
<tr>
<td>Evaluate Recommendation Condition</td>
<td>Evaluate the conditions and script specified for the recommendation.</td>
<td>• Record count</td>
<td>• Result</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Threshold</td>
<td>• Score</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Direction</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Recommendation</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Activity record</td>
<td></td>
</tr>
</tbody>
</table>
Connect spoke

Provides actions to automate the creation of conversations, to add users to a conversation, and to send messages to a conversation. These actions work with Connect API version 3 and later.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Group Users to Task Conversation</td>
<td>Create a task conversation, and add all users of a group to it.</td>
</tr>
<tr>
<td>Add User to Task Conversation</td>
<td>Create a task conversation, and add a user to it.</td>
</tr>
<tr>
<td>Send Message to Task Conversation</td>
<td>Send a message to all users of a task conversation.</td>
</tr>
</tbody>
</table>

Customer Service Spoke


<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Case</td>
<td>Retrieve a case record using the case number. If multiple records are found, only the first record is returned.</td>
</tr>
<tr>
<td>Create Case</td>
<td>Create a case using one or more attributes. This action mimics the structure of the Case table (sn_customerservice_case) and exposes the fields present on the Case table.</td>
</tr>
<tr>
<td>Create Quick Case</td>
<td>Create a case using the customer, description, channel, priority, and category attributes.</td>
</tr>
<tr>
<td>Create Task on Case</td>
<td>Create a case task and optionally associate it with a case.</td>
</tr>
<tr>
<td>Update Case</td>
<td>Update a case by providing the case reference and the fields that you want to update.</td>
</tr>
<tr>
<td>Assign Case</td>
<td>Assign a case using matching rules. To use this action, you must first define the matching rules that match cases with resources (assignment groups, agents).</td>
</tr>
<tr>
<td>Escalate Case</td>
<td>Request case escalation. This action does not automatically approve escalation. Approval is based on the selected escalation template.</td>
</tr>
<tr>
<td>Escalate Account</td>
<td>Request account escalation. This action does not automatically approve escalation. Approval is based on the selected escalation template.</td>
</tr>
<tr>
<td>Add Work Note to Task</td>
<td>Add a work note to a task or to task extended objects (for example, a case or case task).</td>
</tr>
<tr>
<td>Add Comment to Task</td>
<td>Add a comment to a task or to task extended objects (for example, a case or case task).</td>
</tr>
</tbody>
</table>

Field Service Spoke

Provides actions for flow designers to use when creating Field Service Management business processes.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Work Order</td>
<td>Retrieve a work order record using the work order number. If multiple records are found, only the first record is returned.</td>
</tr>
<tr>
<td>Create Work Order</td>
<td>Create a work order and optionally associate it with a case.</td>
</tr>
<tr>
<td>Update Work Order</td>
<td>Update a work order by providing the work order reference and the fields that you want to update.</td>
</tr>
<tr>
<td>Get Work Order Task</td>
<td>Retrieve a work order task record using the work order task number. If multiple records are found, only the first record is returned.</td>
</tr>
<tr>
<td>Create Work Order Task</td>
<td>Create a work order task and optionally associate it with a work order.</td>
</tr>
<tr>
<td>Update Work Order Task</td>
<td>Update a work order task by providing the work order task reference and the fields that you want to update.</td>
</tr>
<tr>
<td>Add Work Note to Task</td>
<td>Add a work note to a task or to task extended objects (for example, a work order or work order task).</td>
</tr>
</tbody>
</table>

**External Related Files**

External Related Files stores information about files in third-party systems and helps you manage the information.

**External Related Files spoke tables**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Provider [sn_ext_files_spoke_provider]</td>
<td>Stores information about the external provider. For example, Box or DocuSign services.</td>
</tr>
<tr>
<td>External Related Files [sn_external_related_files]</td>
<td>Stores metadata information about the files in third-party systems. This table is extensible.</td>
</tr>
</tbody>
</table>

**Note:** If you extend the table, ensure that you perform the data separation for the scoped applications.

- To store metadata information of files in a specific third-party system, create a table with a column that contains a reference field to the External Related Files table. For more information about reference fields, see reference field type.
- To establish a relationship between a specific ServiceNow table and External Related Files table, create defined related lists.
## External Related Files spoke actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create External File Record</td>
<td>Creates a record in the External Related Files table.</td>
</tr>
<tr>
<td>Update External File Record</td>
<td>Updates a record in the External Related Files table.</td>
</tr>
<tr>
<td>Delete External File Record</td>
<td>Deletes a record in the External Related Files table.</td>
</tr>
</tbody>
</table>

## External Related Files spoke user roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_ext_files_spoke.doc_reader</td>
<td>Read records in the External Related Files and External Provider tables.</td>
</tr>
<tr>
<td>sn_ext_files_spoke.file_admin</td>
<td>• Read, update, and delete records in the External Related Files table.</td>
</tr>
<tr>
<td></td>
<td>• Read records in the External Provider table.</td>
</tr>
<tr>
<td>sn_ext_files_spoke.provider_admin</td>
<td>Read, update, and delete records in the External Provider table.</td>
</tr>
</tbody>
</table>

## ITSM spoke

Provides flow and actions associated with ITSM. Requires the ITSM application suite.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Comment</td>
<td>Adds a comment to a task record.</td>
</tr>
<tr>
<td>Add Worknote</td>
<td>Adds a work note to a task record.</td>
</tr>
<tr>
<td>Assign Incident to CI Support Group</td>
<td>Updates an incident record to assign it to the CI Support Group.</td>
</tr>
<tr>
<td>Create Catalog Task on Request</td>
<td>Creates a Catalog Task record from a Request record.</td>
</tr>
<tr>
<td>Create Catalog Task on Request Item</td>
<td>Creates a Catalog Task record from a Request Item record.</td>
</tr>
<tr>
<td>Create Change Task on Change Request</td>
<td>Creates a Change Task record from a Change Request record.</td>
</tr>
<tr>
<td>Create Emergency Change Request</td>
<td>Creates a Change Request record of type Emergency.</td>
</tr>
<tr>
<td>Create Emergency Request from Incident</td>
<td>Creates a Change Request record of type Emergency from an Incident record.</td>
</tr>
<tr>
<td>Create Incident</td>
<td>Creates an Incident record.</td>
</tr>
<tr>
<td>Create Incident Task on Incident</td>
<td>Creates an Incident Task record from an Incident record.</td>
</tr>
<tr>
<td>Create Normal Change Request from Incident</td>
<td>Creates a Change Request record of type Normal from an Incident record.</td>
</tr>
<tr>
<td>Create Outage</td>
<td>Creates a cmdb_ci outage record for a configuration item. The Task field is populated only if the source is a task record. If the source is non-task record such as an alert record, the Task field is empty.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create Problem from Incident</td>
<td>Creates a Problem record from an Incident record.</td>
</tr>
<tr>
<td>Create Request</td>
<td>Creates a Request record.</td>
</tr>
<tr>
<td>Create Standard Change Request</td>
<td>Creates a Change Request record of type Standard.</td>
</tr>
<tr>
<td>Create Task</td>
<td>Creates a child task record for a Task table record. For example, creates an Incident Task record for an Incident record.</td>
</tr>
<tr>
<td>Create Task Outage Relationship</td>
<td>Creates a Task Outage Relationship record where cmdb_ci outage record and task record are inputs to the action.</td>
</tr>
<tr>
<td>Create Standard Change Request from Incident</td>
<td>Creates a Change Request record of type Standard from an Incident record.</td>
</tr>
<tr>
<td>Update Assignee</td>
<td>Updates the Assigned to field of a Task table record.</td>
</tr>
<tr>
<td>Update Assignment Group</td>
<td>Updates the Assignment Group field of a Task table record.</td>
</tr>
</tbody>
</table>

**Security Operations spoke**


**Security Incident Response flow templates**

The Security Incident Response flow templates are created using the Flow Designer.

⚠️ **Note:** Each of the flows is triggered when the Category in a security incident is set or changed.

<table>
<thead>
<tr>
<th>Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#unique_957</td>
<td>Perform a series of tasks designed to handle the exposure of sensitive data.</td>
</tr>
<tr>
<td>#unique_958</td>
<td>Perform a series of tasks designed to handle Denial of Service (DOS) attacks.</td>
</tr>
<tr>
<td>#unique_959</td>
<td>Perform a series of tasks designed to handle lost equipment.</td>
</tr>
<tr>
<td>#unique_960</td>
<td>Perform a series of tasks designed to handle malicious software on your network.</td>
</tr>
<tr>
<td>#unique_961</td>
<td>Perform a series of tasks designed to handle spear phishing emails on your network.</td>
</tr>
<tr>
<td>#unique_962</td>
<td>Perform a series of tasks designed to handle security policy violations.</td>
</tr>
<tr>
<td>#unique_963</td>
<td>Perform a series of tasks designed to handle reconnaissance on your network.</td>
</tr>
<tr>
<td>#unique_964</td>
<td>Perform a series of tasks designed to handle activity from rogue servers or services affecting your network.</td>
</tr>
<tr>
<td>Template</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>#unique_965</td>
<td>Perform a series of tasks designed to handle email spam on your network.</td>
</tr>
<tr>
<td>#unique_966</td>
<td>Perform a series of tasks designed to handle unauthorized access to your network.</td>
</tr>
<tr>
<td>#unique_967</td>
<td>Perform a series of tasks designed to handle vandalism directed against one of your BBS or web sites.</td>
</tr>
</tbody>
</table>

**Visual Task Board (VTB) Spoke**

Provides VTB actions for flow designers to manage the boards, lanes, cards, board members, and assignees.

**Board Management Actions**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Action Inputs</th>
<th>Action Outputs</th>
</tr>
</thead>
</table>
| Create Freeform VTB Action | Creates a Freeform VTB for any task type. The default lanes are: Todo, Doing, and Done. These lanes can be modified with actions: Add Lane, Rename Lane, Reorder Lane, and Delete Lane | • Name  
• Board Owner  
• Default view  
• Label visibility  
• Picker visibility  
• Background color | • Board record |
| Create Flexible VTB Action | Creates a Flexible VTB bound to a single Task table. The default lanes are: Todo, Doing, and Done. These lanes can be modified with actions: Add Lane, Rename Lane, Reorder Lane, and Delete Lane | • Name  
• Task table  
• Filter  
• Board Owner  
• Default view  
• Label visibility  
• Picker visibility  
• Background color | • Board record |
| Create Guided VTB Action | Creates a data-driven VTB bound to a single Task table along with the fields the lanes are derived. | • Name  
• Task table  
• Land field  
• Filter  
• Board Owner  
• Default view  
• Label visibility  
• Picker visibility  
• Background color | • Board record |
| Add VTB Member Action | Add a user to a VTB. Only members of the VTB can access the board, Any VTB member can add other members. | • Board record  
• User record | N/A |
### Remove VTB Member Action

**Description**
Remove a user from a VTB. Only members of a VTB can access the board. Any VTB member can remove other members.

**Action Inputs**
- Board record
- User record

**Action Outputs**
N/A

### Lane Management Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Action Steps</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add VTB lane</td>
<td>Add a lane to a Freeform or Flexible VTB. This action does not apply to Guided boards, which are constrained to fixed lanes based on fields configured.</td>
<td>• Board record&lt;br&gt;• Lane name</td>
<td>VTB lane record</td>
</tr>
<tr>
<td>Rename VTB Lane</td>
<td>Rename an existing lane on a Freeform or Flexible VTB.</td>
<td>• Lane record&lt;br&gt;• New lane name</td>
<td>N/A</td>
</tr>
<tr>
<td>Reorder VTB Lane</td>
<td>Reorder lanes on any VTB.</td>
<td>• Lane record&lt;br&gt;• New lane name</td>
<td>N/A</td>
</tr>
<tr>
<td>Delete VTB Lane</td>
<td>Delete an existing lane from a Freeform or Flexible VTB.</td>
<td>• Lane record</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Card Management Actions

<table>
<thead>
<tr>
<th>Flow/Action</th>
<th>Description</th>
<th>Action Steps</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create VTB Card</td>
<td>Create a VTB card on a Freeform board for a task.</td>
<td>• Lane record&lt;br&gt;• Task record</td>
<td>Card record</td>
</tr>
<tr>
<td>Assign VTB Card</td>
<td>Assign a user to a VTB card.</td>
<td>• Card record&lt;br&gt;• User record</td>
<td>N/A</td>
</tr>
<tr>
<td>Move VTB Card</td>
<td>Move a VTB card from one lane to another lane.</td>
<td>• Card record&lt;br&gt;• Lane record</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Note:** For Flexible boards, use the Update Record action to change the state of the underlying task. For Guided boards, this action changes the field on the task associated with that card.

<table>
<thead>
<tr>
<th>Remove Assignee from VTB Card</th>
<th>Description</th>
<th>Action Steps</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Remove an assignee from a card.</td>
<td>• Card record</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Instance Data Replication (IDR)

() copies data updates from one instance to one or more other instances. enables you to maintain consistent data across different organizations in your company.

IDR provides a one-to-many replication, which enables one instance to propagate data across different departments and business units to keep data in sync. IDR can also modify data during replication, for example, to localize the data.

Benefits

• Automatic replication of data to one or more other instances.
• Producer data can be modified and mapped to any table and table column on consumer instances, for example, to localize data for different locales.
• Data updated on consumer instances can be replicated to the producer instance.
  
  This feature enables you to give data, such as problem requests, on consumer instances to third parties, which can update the problem issue and return it to the consumer instance. That updated data can then be updated on the producer.
• Business rules can trigger post-replication workflows, such as generating notifications or validating the replication.
• Data in transit during a crash is recoverable.

How Instance Data Replication works

Use the Instance Data Replication plugin to replicate data updates on one instance, called the producer instance, to one or more other instances, called consumer instances.

A producer replication set specifies the tables and table columns on the producer instance to replicate. A consumer data set specifies the tables and table columns on consumer instances that receive the producer replication set data.

Activating both producer and consumer replication sets turns on IDR functionality. Data updated in a producer replication set automatically updates the corresponding data in consumer replication sets.

Syncing the producer and consumer replication sets requires that you do a one-time download called seeding of all the producer replication set data to the consumer instances. You can initiate seeding requests on a consumer instance while you are activating a consumer replication set. After seeding, your future replications involve data updates only. An audit trails contain a history of those record updates.

By default, table data on a producer instance goes into tables of the same name on consumer instances. Transformation is the process of replicating producer data in differently-named tables or table columns on consumer instances.

IDR adapters modify data before storing it on consumer instances. Adapters perform string and mathematical operations, such as converting one currency to another, or converting one time zone to another.
IDR overview

Warning: IDR overwrites data on instances and can replicate sensitive data. Given the potential for data loss and data exposure, test your IDR implementation in a pre-production environment.

Domain separation

IDR runs in ServiceNow data centers only. It functions at the data level so IDR does not explicitly support domain separation. Data moves from a producer to a consumer without regard to domain. However, you can use business rules to convert from one domain to another. For more information, see About Before Query business rules.

When not to use IDR

• Do not use IDR to clone instances.

IDR does not replicate metadata tables, child metadata tables, and most user and system tables. IDR is designed to replicate data, not clone instances.
• Do not use IDR if your use case breaks any of the following IDR limitations:
  • Replication must not take longer than 7 days to complete.
  • Initial seeding of the tables must be less than 3 million records per replication set.
  • Producer and consumer instances must be in the same geographic region.

What to do next

Get an overview of setting up IDR.

Set up Instance Data Replication (IDR)

IDR requires a separate subscription and only ServiceNow personnel can install the plugin. Once the plugin activates, you can configure the producer and consumer instances.

Role required: admin

1. Request that ServiceNow install the IDR plugin.
2. Create and activate a producer replication set.
   The producer replication set specifies the tables and table columns you want to replicate to one or more consumer instances.
3. Create and activate one or more consumer replication sets and request data from the producer.
   The consumer replication set specifies the tables and table columns on consumer instances that receive producer data updates. Replicated data overwrites corresponding consumer instance data. Consumers must apply to producers to receive replication data.
4. Approve or deny consumer requests to access replication data on your producer instance. to access replication data.

   Note: You must have the producer replication admin role to approve or deny consumer requests.

5. Optional: Map replicated data into different tables or table columns on consumer instances.
6. Optional: Modify records during replication.
   As an example, you might change time zone or currency records to make them appropriate for a different geographic region.
7. Optional: Set up bi-directional replication.

Request an Instance Data Replication (IDR) subscription

The Instance Data Replication (IDR) plugin requires a separate subscription and must be activated by ServiceNow personnel.

Role required: admin

The IDR plugin ID is com.glide.idr. When purchasing an IDR subscription, ServiceNow personnel also activate the following plugins that IDR depends upon:

• com.snc.db.data_replicate
• com.glide.transform
• com.glide.kmf
To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and sub-production instances, generally within a few days.

If you do not have an account manager, decide to delay activation after purchase, or want to evaluate the product on a sub-production instance without charge, follow these steps.

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.

4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments.</td>
</tr>
</tbody>
</table>

Note: Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

5. Click Submit.

Create and activate a producer replication set.

Create a producer replication set in Instance Data Replication (IDR)

You can use a producer replication set to specify the tables and table columns to replicate on consumer instances.

- You purchased an IDR subscription and ServiceNow personnel installed the IDR plugin.
- Verify that the producer and consumer instances are in the same geographic region and belong to the same customer.
- Role required: idr_admin or admin

Seeding is the initial download of all the records in the producer replication set to the tables in the consumer replication set. After seeding, IDR only replicates data updates. When creating a replication set, you must observe the following seeding limitations:
- Maximum record size is 32 MB.
- Maximum seeding size is 3 million records.

**Note:** If your replication set contains more than 3 million records, seeding will not even start. To remedy this situation, break the replication set into multiple replication sets with fewer records in each.

- Maximum seeding time is 7 days.

1. On the producer instance, navigate to Instance Data Replication > Producer Replication Sets and click New to create a new replication set.
2. In the **Name** and **Description** fields, add a name and description and then click **Submit**. Names can only contain alphanumeric characters and hyphens. The consumer replication set must have the same name as the producer replication set, so you may not want to have "producer" in the title.

In the Producer Replication Set form, the system auto-generates the producer ID, which you can't edit. The **Producer ID** field identifies the producer instance in the system.
3. Optional: Select **Require Consumer Sync** to enable bidirectional replication on consumer instances. Bidirectional replication replicates changes made directly on consumer instances back to the producer instance. For bidirectional replication to happen, the consumer replication set must synchronize the configuration changes. Bidirectional replication only works for records that originated on the producer. For more information, see **Bidirectional replication**.
4. Identify the table and the table columns to include in the replication set.
   a) On the Replication Entries tab, click New.

   ![Replication Entry form]

   b) In the Source Table name field, select one of the tables on the producer instance to replicate.
      For example, select Incident.
c) Optional: Select the **Include Attachments** option to replicate files that are associated with the records that are being replicated.

d) Optional: To prevent a group of records in selected table from being replicated, create a filter by clicking **Add Filter Condition** and selecting filter criteria in the **Filter** section.

For example, you might want to replicate only active records. In that case, select **Active** in the – **choose field** – list, **is** in the – **oper** – list, and **True** in the – **value** – list. If you do not use a filter, all the fields in the producer replication set table appear in the Available column.

**Note:** The Available column contains the fields in the Source Table that you specified. That table may not contain the **Active** field.

e) In the Included Fields columns, use the arrows to move table fields into the Selected column to replicate them or into the Available column to prevent replicating them, and then click **Submit**.
Some fields, such as **SYS ID (Mandatory)**, must be replicated. Other fields, such as **Edge Encrypted** and **Password1**, can't be replicated and do not appear in either column.
5. Repeat step 4 for each table you want to include in the replication set.

   **Note:** If the table you add to the replication set has child tables, add the child tables to the replication set to maintain data integrity.

6. Click Activate.

   Replication can't happen until you link the producer replication set to one or more consumer replication sets. Activation just makes the producer data available for replication.

7. Click the **Replication Setup Instructions** related link to view the information and close the modal.

   The Replication Setup Instructions modal shows important configuration information that you use to associate this producer instance with its consumer instances.

8. Click the **Notification Configuration** related link and configure who receives replication notifications.
   a) On the **When to send** tab, specify the conditions for sending a notification.
   b) On the **Who will receive** tab, specify who receives the notifications.

   The fields that are displayed on the tab vary with the **Send when** value:
   - **Record inserted or updated**—The **Updated** and **Inserted** options, when selected, send notifications when records are updated or inserted.
   - **Event is fired**—The Event Name specifies the event type that sends the notification.
   - **Triggered**—A notification is sent when triggered by a Flow Designer flow. For more information, see Flow Designer.

   The **Updated** and **Inserted** options, when selected, send notifications when records are updated or inserted.
   c) On the **What it will contain** tab, specify the notification content.
   d) Click **Update**.

The producer is ready to send the data that is specified in the replication set to one or more consumer instances.

   **Note:** If you believe that a consumer set should no longer receive replication data, you can revoke the consumer set's access.

- Create and activate a consumer replication set.
- Grant access to replication data.

After creating a consumer replication set, you must ask for permission to receive the producer's replication data. See Grant access to replication data to see how to grant or deny access.

### Reconfigure a replication set in Instance Data Replication (IDR)

You can reconfigure replication sets on the producer instance if you need to change or update your original replication set.

**Role required:** idr_admin or admin

After activating a revised producer replication set, update the producer replication set's name, shared key, producer ID, and producer set ID on each consumer instance.
**Note:** Make sure that a seeding request is not in progress before you reconfigure a producer instance. Check the consumer replication sets seeding requests status.

1. Reconfigure a producer instance:
   a) On the producer instance, navigate to **Instance Data Replication > Producer Replication Sets**.
   b) Select a producer replication set and make one or more of the following changes to the set:
      - On the **Replication Entries** tab, click **New** to add a table to the set.
      - On the **Replication Entries** tab, click a replication set and in the Replication Entry form, modify the columns included in the replication set and click **Update**.
      - On the **Replication Entries** tab, click a replication set and click **Delete** to remove the table from the replication set.
      - Click **Generate New Shared Key** to change the shared encryption key.

      You only generate new shared keys when you discover that they have been compromised or if you want to stop sending data to a consumer. After changing the encryption key on the producer instance, consumers that have the Consumer Approved Status of Denied must reapply for access to the producer replication set. For more information, see Grant access to replication data.

      These changes stop replication and produce this status message on the consumer instance: “Producer Replication Set configuration has been modified.” On the consumer instance, click **Synchronize Replication Configuration** and then click **Activate with Seeding**.

2. To update consumers with the changes made on the producer, on each consumer instance, navigate to **Instance Data Replication > Consumer Replication Sets** and click the consumer replication set you want to update. The status of the replication set is **Replication Error**. Use the table to take action according to the **Status Message**.

<table>
<thead>
<tr>
<th>Status Message</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval was denied by producer instance</td>
<td>The producer changed the shared key and this consumer’s access to the replication data was revoked. Replication stops. Click <strong>Request shared key</strong> under Related Links. The producer must approve your request. For more information, see Grant access to replication data. If the consumer’s access was not revoked, replication continues; nothing needs to be done on the consumer instance.</td>
</tr>
<tr>
<td>Producer Replication Set configuration has been modified.</td>
<td>The producer added or subtracted tables or table columns in the producer replication set. Replication stops. Click <strong>Synchronize Replication Configuration</strong> and then <strong>Activate with Seeding</strong>. If the producer set contains fewer tables, you can click <strong>Activate Without Seeding</strong> instead. The tables on the consumer instance that the producer instance no longer replicates are not deleted.</td>
</tr>
</tbody>
</table>

3. Optional: Delete a replication set.
   - To delete a producer replication set from the producer instance, navigate to **Instance Data Replication > Producer Replication Sets**, click the producer replication set you want to delete, and then click **Delete**.
   - To delete a consumer replication set on a consumer instance, navigate to **Instance Data Replication > Consumer Replication Sets**, click the consumer replication set you want to delete, and then click **Delete**.
Create a consumer replication set for Instance Data Replication (IDR)

You can use a consumer replication set to specify the tables and columns on a consumer instance that receives the producer data.

- Create and activate a producer replication set.
- Make sure the producer and consumer instances are in the same geographic region and belong to the same customer.
- Role required: admin or idr_admin

Create a consumer replication set and link it to a producer replication set. Data from the producer replicates into tables and table columns of the same name on the consumer instance. The admin of the producer replication set must grant the consumer instance access to replication data.

If in the future the producer replication set admin generates a new encryption key, which is responsible for encrypting the replication data, the encryption key value stored in the consumer replication set may or may not be automatically updated. If not, replication stops. To restore access, see Restore access to replication data.

1. On a consumer instance, navigate to Instance Data Replication > Consumer Replication Sets.
2. Click New to create a new replication set.
   The Consumer Replication Set form appears. The values associate the consumer instance with a specific producer instance.

3. Get the values for the form from the producer administrator. Alternately, if you have access to the producer instance:
   a) On the producer instance, navigate to Instance Data Replication > Producer Replication Sets.
   b) Select a producer replication set.
   c) Under Related Links, click Replication Setup Instructions.
      The values for the Consumer Replication Set form appear.
4. Copy and paste all the information exactly as it is in the producer instance into the Consumer Replication Set form and click Submit. This action sends a request to the producer replication set admin to approve or deny your request for a shared encryption key.

⚠️ **Warning:** Do not change any of the values, including the name.

The list of all consumer replication sets appears.
5. Click the replication set.
   The **Consumer Replication Set** pane appears.
Notice that **Consumer Approval Status** says **Approval Pending**. The producer admin must approve your request to be a consumer.

**Note:** If you receive an error that your encryption key does not work, call ServiceNow support.

6. Wait until the producer admin approves the request. The **Consumer Approval Status** changes to **Approved**. For more information, see Grant access to replication data.

7. After you receive confirmation, click **Synchronize Replication Configuration** under **Related Links**. If you do not see this option, refresh the page. A modal confirms the synchronization. The tables selected for replication in the producer replication set are replicated in the consumer replication set and appear on the Consumer Replication Entries tab. The initial seeding of all the table data may take some time. In the future, only data updates are replicated to consumer replication sets. For more information about seeding, see Seed a consumer instance.

   a) On the **When to send** tab, specify the trigger for sending a notification.
   b) On the **Who will receive** tab, specify who receives the notifications.
   c) On the **What it will contain** tab, specify the notification content.
   d) Click **Update**.

9. Activate the consumer replication set by selecting the check box next to the replication set you want to activate and clicking one of the following buttons on the **Consumer Replication Entries** tab:
   - **Activate with Seeding** — Makes the replication set ready to take producer updates and replicates the current records (only) specified in the producer replication set.
   - **Activate with Seeding (Include History)** — Same as **Activate with Seeding** but also replicates the entire history of record updates.

With both seeding options, IDR generates audit trails of all record updates going forward. If you encounter an error during seeding, see Fix seeding errors. For more information about seeding, see Seed a consumer instance.

**Note:** **Activate without Seeding** under **Related Links** makes the replication set ready to take producer updates but does not download any data from the producer. Do not use this option when setting up replication. Always start with seeding the consumer instance. Use this option, for example, after updating the producer’s ID, producer set ID, or encryption key.

10. Optional: To cancel a seeding request:
   a) On the **Seeding Requests** tab, click a seeding request.
   b) On the Seeding Request form, click **Cancel**.

11. Optional: To modify the behavior of the consumer, on the **Consumer Replication Entries** tab, click a source table name.
   a) On the Consumer Replication Entry form, select the **Preserve Modified By** check box to add the name of a user to an **Activities** entry.

   **Preserve Modified By** preserves on consumers the name of the person who updated a field of type Activity in a record. For example, the **Work notes** field is of type Activity in change request records. When someone updates a change request, the work note moves into the **Activities** stream. If the check box is unselected, the **Activities** entry attributes the update to Instance Data Replication in consumer records. With the check box selected, the person who updated the
change request is identified in the entry; “IDR,” is prepended to their name. The following image shows the Activities entry with (top) and without (bottom) the Preserve Modified By check box selected.

b) To run business workflows after a replication, select the Run Business Rule check box.

A business rule is a server-side script associated with a table. Use business rules to trigger workflows associated with replications, such as sending a notification or validating the replicated data. For more information, see Trigger workflows after replication.

c) To replicate data from the producer tables into tables of different names on the consumer, click Enable Transform.

For more information, see Transform replication data.

d) If you made any changes, click Update.

The consumer instances contain, at a minimum, the current data in producer replication set tables. The consumer instances are now ready to accept replicated data updates. By default, the data in producer tables is replicated into tables and table columns of the same name on the consumer instances. Transform replicated data describes how to map the data into different tables and table columns, and how to modify the data as it is replicated.

• Map the replication data to different tables on the consumer instance.

• Modify the values during replication.
• Set up business rules to trigger post-replication workflows.

Grant access to the replicated data for Instance Data Replication (IDR)

Admins of consumer sets must apply to receive replication data. As the producer replication set administrator, you must approve or deny that request.

Role required: admin for a producer replication set

You can review consumer access requests for all of your producer replication sets or for a specific producer replication set.

1. To review and approve consumer access requests for all of your producer replication sets:
   a) On the producer instance, navigate to Instance Data Replication > Consumers Pending Approval.
      All of the consumer replication sets pending approval appear.
   b) Select the check box for each consumer replication set you want to approve.
   c) On the Actions on selected rows... drop-down, select Approve.
      The approved consumer sets start receiving replicated data.

   Note: In the future, you can change the Consumer Approval Status to Denied to prevent the consumer from receiving replication data.

2. To review and approve a consumer access request for a specific producer replication set:
   a) On the producer instance, navigate to Instance Data Replication > Producer Replication Sets.
   b) Select the producer replication set where you want to approve consumer access.
   c) Under Related Links, on the Consumer Subscriptions tab, select the check box for the consumer replication set you want to approve.
   d) On the Actions on selected rows... drop-down, select Approve.
      The approved consumer set starts receiving replicated data.

   Note: In the future, you can change the Consumer Approval Status to Denied to prevent the consumer from receiving replication data.

Revoke access to replicated data for Instance Data Replication (IDR)

If you believe that a consumer should no longer receive replicated data, you can revoke the consumer’s access.

Role required: producer instance admin

When you generate a new, shared encryption key, approved consumer sets automatically receive the new key and data replication is not interrupted. Any consumer set with a status of Denied or Pending Approval will not receive the new encryption key, and replication ceases.

1. On the producer instance, navigate to Instance Data Replication > Producer Replication Sets
2. Select the producer replication set that has consumers whose access needs to be revoked. The Producer Replication Set page appears.

3. On the **Consumer Subscriptions** tab, select the check box for the consumer instance whose permissions you want to revoke.

4. On **Actions on selected rows...**, select **Revoke**. Instance Data Replication generates a new encryption key and shares it with all approved consumer sets. All other consumer sets stop receiving replication data. Admins of those consumer replication sets must **reapply to restore access to the replication data**.

**Restore access to replication data for Instance Data Replication (IDR)**

If the producer replication set admin generates a new encryption key, all consumer sets stop receiving replication data if the consumer's status is **Denied** or **Pending Approval**. To restore access, the consumer set admin must send a request.

Role required: consumer instance admin

When the producer replication set admin generates a new encryption key, approved consumer sets automatically receive the new key, and data replication is uninterrupted. Consumer sets with a status of **Denied** or **Pending Approval** do not receive the new encryption key and replication ceases.

1. On the consumer instance, navigate to **Instance Data Replication > Consumer Replication Sets**.
2. Select the consumer replication set to restore access to.
3. Under Related Links, click Request Shared Key.
   A request is sent to the producer replication set admin. If you are granted access, the consumer’s Approval Status changes to Approved.
4. Under Related Links, click Synchronize Replication Configuration in case the producer’s replication set changed.
5. On the Consumer Replication Entries tab, select all of the tables and in click Activate with Seeding to get the latest data in the producer's replication set.

### Transform replication data for Instance Data Replication (IDR)

Transform the producer instance data to tables or table columns that are named differently on consumer instances.

- Create and activate a producer replication set.
- Create, activate, and seed one or more consumer replication sets.
- Role required: admin or idr_admin

By default, replicated data from producer tables and table columns goes into tables and table columns of the same name on consumer instances. You can, however, map producer data into any table or table column on consumer instances. You might replicate the data to a different table or table column because existing tables or table columns you replicate to have different names.

You can also use adapters to modify producer data during replication, for example, to localize the data, or to populate data that has been labeled differently in consumer tables.

Transformations have the following limitations:

- sys_created, sys_created_by, sys_domain, sys_updated_by, sys_id, and sys_mod_count are automatically mapped to the consumer and cannot be remapped.
  No other sys_ fields can be replicated.
- Adapters cannot operate on the sys_journal field type, for example, on Comments or Worknotes columns in a Task table.
- Calculated fields cannot be transformed.
  For example, sys_user is a combination of first and last name fields. If the source and target fields have the same names, the calculated fields are replicated. Attempting to remap calculated fields breaks the calculation.

1. On the consumer instance, click Instance Data Replication > Consumer Replication Sets and click a consumer replication set.

3. Select the Enable Transform check box.

4. In Target Table Name, select the table into which to replicate the source table data and click Update.

5. On the Consumer Replication Entries tab, click the same consumer replication entry.
6. Click the lock icon next to **Transform Map** to unlock it. The **Transform Map** appears. Field names from the source table appear in the left column. The middle column shows matching field names in the target table. All fields that do not have the same names in both tables appear in the **– choose source field –** or **– choose target field –** drop-downs.

<table>
<thead>
<tr>
<th>Enable Transform</th>
<th>Target Table Name</th>
<th>Transform Map</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** If a table in a producer replication set is not on a consumer instance, the table is created on the consumer instance. If there are no entries in the **– choose source field –** and **– choose target field –** columns, the producer and consumer tables do not have identically named columns. Grayed out values are not configurable.

7. To map a producer column to a consumer column that has a different name:
   a) Click **– choose source field –** and select the source field you want to map.
   b) Click **– choose target field –**, select the target field into which you want to map the data, and then click **Add**.
   c) If you want to remove a field from replicating from the producer to the consumer, click the **X** at the end of the row to delete the field.
8. To modify the producer data before replicating it in the consumer instance, click **Add Adapter**. The What kind of Adapter Rule do you want to create? page appears.

![What kind of Adapter Rule do you want to create?](image)

Concatenate String Adapter Rule  
Replace Adapter Rule  
Split Adapter Rule  
Fixed-Width Format Adapter Rule  
Pattern Adapter Rule  
Task Number Adapter Rule  
Calculation Adapter Rule  
Map Adapter Rule  
Time Zone Conversion Adapter Rule

9. Click the adapter you want to use and configure it. 
   For more information about configuring adapters, see Adapter descriptions.

Producer data replicates into different tables or table columns on the consumer instance, or the data is modified, or both.

**Note:** Adapters do not modify data on the producer instance.

Bidirectional replication for Instance Data Replication (IDR)

Bidirectional replication enables data to not only flow from a producer instance to a consumer instance, but also to accept data from a consumer instance and flow back to the producer instance.

By default, replicated data flows from a producer to consumer instances. Bi-directional replication reverses that flow. For example, a company might outsource its networking issues. The third party receives the networking incident records from consumer instances, fixes the networking issues, updates the records, and returns them to the consumer instance. Bi-directional replication then updates the incident records on the producer instance. Bi-directional replication only works for records that originated on the producer.

To make data flow bi-directionally behind the scenes on the consumer instance, the system creates a producer on the consumer instance and a consumer on the producer instance.
Choosing bi-directional replication creates producer and consumer instances

If you look at the replication sets on the original producer instance, you see the replication set name and the automatically generated consumer instance. It has the same name appended with the suffix, -<long-number>-reverse, where <long-number> is a randomly generated number. For example, if Test is the replication set name on the producer, Test-2034802-reverse might be the name of the consumer replication set automatically generated on the same instance. On the original consumer instance, you see the same names. Replication sets with the reverse suffix are read-only.

You can see the automatic creation of a consumer on a producer instance, and a producer on a consumer instance by running https://<producer-instance-name>/xmlstats.do?include=idr and https://<consumer-instance-name>/xmlstats.do?include=idr on the producer and consumer instances, respectively. In the following image, the original producer instance is on the left and the original consumer instance is on the right.
Bi-directional replication has the following limitations:

- Auto-conflict resolution is unsupported.
- Merge conflicts happen if producer and consumer instances modify the same record at the same time. The most recent update wins, which means the data on the consumer and producer tables might be different.
- Deleting data on a consumer instance does not delete the same data on the producer instance.
- Bi-replication supports the Number adapter but none of the others.

Create a bidirectional replication for Instance Data Replication (IDR)

Replicate updated data on a consumer instance to the producer instance.

Role required: admin or idr_admin

1. On a producer instance, navigate to **Instance Data Replication > Producer Replication Sets** and click a producer replication set.

2. On the Producer Replication Set pane, select the **Require Consumer Sync** check box to enable bi-directional replication.

3. On a consumer instance, navigate to **Instance Data Replication > Consumer Replication Sets** and click a consumer replication set connected to the producer replication set.

4. On the Consumer Replication Set pane, click the **Synchronize Replication Configuration** under Related Links.

A check appears in the **Require Consumer Sync** check box.

Data updated on this consumer instance automatically replicates on the producer instance, which in turn replicates the updates to its other consumer instances.

Seed a consumer instance for Instance Data Replication (IDR)

Seed all or some of the tables in your replication sets depending on the needs of your consumer instance.

Role required: admin or idr_admin
You can initiate seeding requests on a consumer instance while you are activating a consumer replication set.

**Note:** Seeding continues even if errors occur on some consumer tables. You can restart seeding specifically on the tables that have errors or on all tables in a replication set.

Seeding requests have the following limitations:

- Maximum record size is 32 MB.
- Maximum seeding size is 3 million records.

**Note:** If your replication set contains more than 3 million records, seeding will not even start. To remedy this situation, break the replication set into multiple replication sets with fewer records in each.

- Maximum seeding time is 7 days.

1. On the consumer instance, navigate to **Instance Data Replication** > **Consumer Replication Sets** and click a consumer replication set.
2. On the **Consumer Replication Entries** tab, select the check box next to the tables to seed.
3. Click either **Activate with Seeding** to download only the current field values from the producer or **Activate with Seeding (Include History)** to download the current field values and the history of all field updates.
   
   Once seeded, the consumer instance maintains a history of all field updates.

4. To cancel a seeding request:
   
   a) On the **Seeding Requests** tab, click a seeding request.
   
   b) On the Seeding Request form, click **Cancel**.

5. If you encounter an error during seeding, see **Fix seeding errors**.

In a successful seeding, all selected data on a producer instance is replicated on a consumer instance.

- Records that exist on the producer instance and not on the consumer instance are copied to the consumer instance.
- If the identical record exists on a consumer instance, the record on the consumer instance is not modified.
- The sys_ID of the record identifies the record on both instances.
- If a replication set changes and no longer includes a table, the records in the corresponding table on the consumer instances are not altered.
- The producer instance handles one seeding request at a time. When the producer instance is busy with a seeding request, subsequent seeding requests are queued and initiated in the order that they are received.

**Note:** In bidirectional replication, the same rules apply.

**Trigger workflows after replications for Instance Data Replication (IDR)**

Use platform business rules to trigger workflows after replications.

Role required: admin or idr_admin

A business rule is a server-side script associated with a table. Use business rules to trigger workflows associated with replications, such as sending a notification or validating the replicated data.
Business rules are part of the Now Platform. For more information, see Business rules.

1. On a consumer instance, navigate to Instance Data Replication > Consumer Replication Sets and click a consumer replication set.
2. On the Consumer Replication Entries tab, click a replication set table.
3. Select the Run Business Rule check box.
4. Optionally, repeat this procedure for other tables in the replication set.
5. Click Update.
   IDR invokes the business rules associated with the specified table after replicating data to the table.

Resolve errors for Instance Data Replication (IDR)

Review and solve common issues.
Role required: admin or idr_admin

Resolving common issues in (IDR)

Before calling ServiceNow customer support, review the checklist for commonly found issues and solutions.
Role required: admin or idr_admin

1. Make sure that the Name, Shared Key, Producer ID, and Producer Set ID are exactly the same on the producer and consumer instances. The names must match.
2. On the producer instance, navigate to Instance Data Replication > Producer Replication Sets.
3. Select a producer replication set and make sure that the producer replication set status is Active Replication.
   If the status is In Draft, click Activate. Only active producer and consumer replication sets replicate.
4. After creating the consumer replication set, make sure that you click Synchronize Replication Configuration.
   On the Consumer Replication Set page, if there are no tables on the Consumer Replication Entries tab, click Synchronize Replication Configuration.
5. Confirm that the producer and consumer instances are connected:
   a) On the producer instance, navigate to Instance Data Replication > Producer replication set
   b) Select a producer replication set.
   c) Under Related Links, click Open Metadata Logs.
   d) See if the Payload Type INIT_TOPIC has the status Sent.
      If the status is not Sent, the producer instance is not connected to the consumer instances. To connect them, see create a consumer replication set.
   e) Repeat the procedure on the consumer instance and see if there are any records where INIT_TOPIC had the status Sent.
      If the status is not Sent, the consumer instance is not connected to the producer instance. To connect the consumer instance to the producer instance, see create a consumer replication set.
6. See if the producer-side and consumer-side replication jobs are running by navigating to Instance Data Replication > Replication Log and checking the entries in the Source column.
   The entries should have IDRProducerJob and IDRConsumerJob. The Created column specifies when the jobs ran. Make sure the jobs ran recently.
7. To check for payload errors, on either producer or consumer instance navigate to Instance Data Replication > Replication Payload Error. Review the error messages.
Find Instance Data Replication (IDR) errors

You can view metadata for messages between producer and consumer instances, payload error logs, and a message log.

Role required: admin or idr_admin

1. View the producer or consumer metadata logs:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Producer</td>
<td>Navigate to Instance Data Replication &gt; Producer Replication Sets, select a producer replication set and click the Open Metadata Logs related link.</td>
</tr>
<tr>
<td>Consumer</td>
<td>Navigate to Instance Data Replication &gt; Consumer Replication Sets, select a consumer replication set and click the Open Metadata Logs link.</td>
</tr>
</tbody>
</table>

2. On either the producer instance or the consumer instance, to view transformation errors and replications that failed to load:
   a) Navigate to Instance Data Replication > Replication Payload Error.
      In the Replication Payload Error table, if the Source value is Seeding, the error happened during seeding. If the source value is different, the error occurred during a replication set update. If any column breaks during transformation, transformation for the entire table breaks and data is not replicated in the table.
   b) Select an error in the Created column.
      The Error Message field on the Payload Error pane describes the payload error.

3. To view the replication log on either the producer instance or the consumer instance:
   a) Navigate to Instance Data Replication > Replication Log.
   b) Select an entry.
      The Instance Data Replication Log form shows the message and message level.

Review synchronization errors in Instance Data Replication (IDR)

Review the status field to check that synchronizations are done correctly on the consumer instance.

Role required: admin or idr_admin
Synchronization errors occur when a producer does not send data or a consumer does not receive data.

1. After completing the tasks in Check for common issues, determine if the consumer successfully sent the synchronize request to the producer.
   a) On the consumer instance, navigate to **Instance Data Replication > Consumer Replication Sets**.
   b) Select a consumer replication set.
   c) Under Related Links, click **Open Metadata Logs**.
   d) Sort the logs in descending order based on the **Log Sequence** column.
   e) Find the most recent payload with the REPL_SET_DETAIL_REQUEST type.
      If you do not see this payload type, refresh the log until you see REPL_SET_DETAIL_REQUEST.
   f) Verify that the **To** column shows the correct producer instance ID.
      If the producer instance ID is incorrect, update the ID and click **Activate Without Seeding** under the Related Links.
   g) Verify that the **Status** column says **Sent**.
      If it does not, the producer did not send updates.

2. Determine if the producer received the synchronize request from the consumer.
   a) On the producer instance, click **Instance Data Replication > Producer Replication Sets**.
   b) Select a producer replication set.
   c) Under Related Links, click **Open Metadata Logs**.
   d) Sort the logs in descending order based on the **Log Sequence** column.
   e) Find the most recent payload with the REPL_SET_DETAIL_REQUEST type.
      If you do not see this payload type, refresh the log until you see REPL_SET_DETAIL_REQUEST.
   f) Verify that the **From** column shows the correct consumer instance ID.
      If the correct consumer instance ID is incorrect, update the ID.
   g) Verify that the **Status** column says **Received**.

### Fix seeding errors

You can retry seeding on tables with seeding errors, which occur from errors such as network problems and failed inserts. This alleviates the need to do a full seeding.

**Role required:** admin or idr_admin

The maximum for a partial reseeding request is 10,000 errors. If you have more, perform a full seeding.

Do not retry seeding if the errors include any of the following problems:
- Record size exceeds 32 MB.
- Seeding request exceeds 3 million records.
- Replication takes longer than seven days to complete.

**Note:** To fix these problems, reduce the number of tables in the seeding request or reduce the size of the records.

1. On the consumer instance, navigate to **Instance Data Replication > Consumer Replication sets**
2. Select a consumer replication set.

3. On the Seeding Requests tab of the Consumer Replication Set pane, click a seeding request that failed.

4. On the Seeding Request pane, click the Payload Errors tab and examine the values in the Message column.
5. Either click **Retry All Errors** or select the check boxes next to the errors to retry, and then click **Retry Selected Errors**.
Diagnose replication delays

Use `xmlstats` to discover if data replication is taking longer than expected.

Role required: admin

The job, IDRProducerJob, runs periodically on producer instances to detect data updates. When IDRProducerJob finds updates, it sends the updates to consumers.

The job, IDRConsumerJob runs periodically on consumer instances to detect data updates from a producer. When IDRConsumerJob finds updates, it updates the data in consumer tables.

It takes some time for data updates in a producer replication set to appear in consumer replication sets. Abnormally long times suggest there might be a problem. You can use `xmlstats` to see the time taken in each step as data updates move from a producer to consumers.

Instances can be both producers and consumers. In that case, running `xmlstats` shows analytics for both. In **Bi-directional replication**, you can see an example.
If you have significant data delays, please contact ServiceNow Technical Support.

1. To view the time lag on a producer, in a browser enter  
   https://<producer-instance-name>/xmlstats.do?include=idr.
   The producer's xmlstats appear.

   • producer_last_run—Last time the replication job ran on the producer's side. Times are in the ISO format, so they're GMT.
   When IDR detects updated data in producer replication sets, the replication job sends the updates to the network. If the job has not run for a while, something might be wrong.
   • replication_queue_reading_lag—How long it takes the data to go from the producer to the network.
   The timer starts when data is updated on a producer instance. The timer stops when IDRProducerJob sends the data updates to the network.
   • For each replication set on the producer, there is a <replset> that contains:
     • name—Name of the replication set.
     • status—Current health of the replication set, either active or error.
     • last_message_sent_on—Last time the producer sent updated data to consumers.
       Times are in the ISO format, so they're GMT. Old timestamps suggest that either data was not updated in this producer replication set or there might be a problem.
2. To view the time lag on a consumer, in a browser enter https://<consumer-instance-name>/xmlstats.do?include=idr.
   The consumer's xmlstats appear.

   ![XMLStats example]

   • consumer_last_run—Last time the consumer job ran that picks up the changes from the producer.
   Times are in the ISO format, so they're GMT. Old timestamps suggest that there might be a problem.
   • For each replication set on the consumer, there is a <replset> that contains:
     • name—Name of the replication set.
     • status—Current health of the replication set, either active or error.
     • data_lag—How long the consumer has not received data updates from the producer.
     Long durations suggest a problem.
     • last_heartbeat_received_on—Timestamp that shows when the consumer last received a heartbeat from the producer.
     Times are in the ISO format, so they're GMT. Producers send heartbeats roughly every minute. Old timestamps suggest that there might be a problem.

**Check for replication entries not populated**

Verify that the producer is replicating data.

Role required: admin or idr_admin

1. Perform the steps in Check for common issues.

   ![XMLStats example]

3. Enter data_replication_state.LIST in the navigation pane.
4. In the `data_replication_state` table, look for the record named `idr.replication.queue.cursor`.
5. Confirm that the value of **Updated by** is `idr.system`, and note the value of **Updated**.
6. If `queue_reading_lag` is greater than 0 and the **Producer cursor last updated time** is less than 60 minutes, the producer encountered an error.
7. If there is an error, look in the syslog, replication log, and localhost log for errors that occurred after the most recent **Producer cursor last updated time**.
   a) To look in the replication log, click **Instance Data Replication > Replication Log**.

### Status messages for Instance Data Replication (IDR)

Review status messages with recovery information.

- **All Producer Replication Sets have been deactivated due to fatal replication error**
  
  All consumer replication sets are moved to the error state. Contact ServiceNow Technical Support.

- **Error while seeding data. Please refer to the Replication Payload Error table for details**
  
  On the consumer instance, more than one record failed to seed. To recover, go to the Replication Payload Error table to find and fix the error, then activate the replication set.

- **Error while seeding data. Please retry seeding this table**

  To recover, reseed the table.

- **Producer has encountered an error while seeding**

  To recover, contact the admin of the producer instance to determine the cause of the problem.

- **Producer Replication Set configuration has been modified**

  To recover, activate the replication set on the consumer instance, either with seeding or without seeding.

- **Producer Replication Set has been deactivated due to replication error**

  Contact ServiceNow Technical Support.

- **Producer Replication Set has been deactivated**

  To recover, activate the producer replication set, and then activate the consumer replication.

- **Producer Replication Set has been deleted**

  To recover, delete the consumer replication set.

- **Producer Replication Set is inactive**

  To recover, activate the producer replication set, and then synchronize and activate the consumer replication set.

- **Producer Replication Set not found**

  To recover, delete the consumer replication set.

- **Replication Set Paused**

  To recover, click **Resume** or **Activate with Seeding**.

- **Replication set was in pause/error/seeding pause state for more than 7 days**

  The consumer replication set has been in the pause state, in an error state, or seeding pause state for more than the timeout period. The replication set is put into the **Disabled** state. To recover, check for seeding errors and activate the replication with seeding.

- **Seeding has been terminated due to timeout**

  To recover, retry the seeding request or contact ServiceNow Technical Support.
• Seeding request for a Producer Replication Set containing more than X number of records is not supported

To recover, change the filter criteria to reduce the number of records to be seeded. The default limit is 10 million records. Contact ServiceNow Technical Support to change the default limit.

• Seeding was cancelled by a consumer admin

To recover, activate the replication set with or without seeding.

• Seeding was cancelled by a producer admin

To recover, activate the consumer replication set with or without seeding. Only seeding requests in Queued, Paused, or Started states can be canceled. In this case, the consumer replication state is Replication Error.

• Shared key not matching

The producer and consumer replication sets have different shared keys. To recover, copy the shared encryption key on the producer replication set, paste it into the consumer replication set, and activate the replication set.

Adapter descriptions for Instance Data Replication (IDR)

During replication, adapters modify producer data before inserting it on consumer instances.

Adapter fields

Each adapter has Name and Description fields. The name appears in the Adapter column on the A. Use the Description field to explain the purpose of the data conversion.

Calculation adapter

Performs the specified mathematical calculation on producer data. Specify the operation and the value used in the operation.

Parameter examples

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation: Multiply</td>
<td>10</td>
<td>10.80</td>
</tr>
<tr>
<td>Constant Value: 1.08</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operation: Max</td>
<td>1020</td>
<td>1000</td>
</tr>
<tr>
<td>Constant Value: 1000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operation: Floor</td>
<td>5.5</td>
<td>5</td>
</tr>
<tr>
<td>Constant Value: 0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Max and Min specify the highest and lowest possible values. Values above or below those limits are set to those limits. Value types such as int and long have maximum and minimum values. Values above or below cause precision errors.
Concatenate String adapter

Appends a specified string to the source data.

Parameter example

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td>String: _v2</td>
<td>Patch10236</td>
<td>Patch10236_v2</td>
</tr>
</tbody>
</table>

Fixed-Width Format adapter

Reformats fixed-width input data. Use # to represent any positive integer, @ to represent any character, and \ as the literal escape character.

Parameter examples

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match: ############</td>
<td>7605551212</td>
<td>(760) 555-1212</td>
</tr>
<tr>
<td>Output: (###) ###-###</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Match: ######</td>
<td>10000</td>
<td>100.00</td>
</tr>
<tr>
<td>Output: ###.##</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Match: ##,###</td>
<td>10,000</td>
<td>10000</td>
</tr>
<tr>
<td>Output: ######</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Map adapter

Use comma-separated pairs of literals to map source-to-target conversions. Matches must be exact. For example, PRB=TASK would not convert PRB1000 to TASK1000.

Parameter examples

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map: PRB=TASK, done=complete</td>
<td>PRB</td>
<td>TASK</td>
</tr>
<tr>
<td>Map: PRB=TASK, done=complete</td>
<td>done</td>
<td>complete</td>
</tr>
<tr>
<td>Map: PRB=TASK, done=complete</td>
<td>PRB1000</td>
<td>(no mapping)</td>
</tr>
</tbody>
</table>

Pattern adapter

Use regular expressions to identify input patterns. Use parentheses in the Regex to identify groups. In Output Pattern, use $ to specify groups. $0 represents the entire input, $1 represents the first group, $2 represents the second group, and so on. You can also insert, prefix, and append literal characters, including spaces so they appear in the adapter output.
### Parameter examples

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Regex</strong>: (.*),(.* )</td>
<td>Smith, John</td>
<td>John Smith</td>
</tr>
<tr>
<td><strong>Output pattern</strong>: $2 $1</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Regex</strong>: (ABC[a-zA-z][a-zA-z]) (ABC[a-zA-z][a-zA-z])</td>
<td>ABCDEABCFG</td>
<td>ABCDE ABCDEABCFG</td>
</tr>
<tr>
<td><strong>Output pattern</strong>: $1 $0</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Regex</strong>: (ABC[a-zA-z][a-zA-z]) (ABC[a-zA-z][a-zA-z])</td>
<td>ABCDEABCFG</td>
<td>ABCDE release ABCDEABCFG</td>
</tr>
<tr>
<td><strong>Output pattern</strong>: $1 release $0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the second example, the match is ABC followed by two letters, followed by ABC and two letters. $1 of this input is ABCDE. $2 of this input is ABCFG. $0 is the entire input string. So $1 $0 is ABCDE ABCDEABCFG.

### Replace adapter

Replaces a specified input string or substring with a specified string. Use $ to replace only some of the occurrences of the string. $1 replaces only the first occurrence; $2 replaces only the second. Use curly braces to replace the first N occurrences. For example, $\{3\}$ replaces the first three occurrences.

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Find</strong>: London</td>
<td>The product is London. The product is London. The product is London.</td>
<td>The product is Madrid. The product is Madrid. The product is Madrid.</td>
</tr>
<tr>
<td><strong>Replace</strong>: Madrid</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Find</strong>: $2 London</td>
<td>The product is London. The product is London. The product is London.</td>
<td>The product is London. The product is Madrid. The product is London.</td>
</tr>
<tr>
<td><strong>Replace</strong>: Madrid</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Find</strong>: $(2)$ London</td>
<td>The product is London. The product is London. The product is London.</td>
<td>The product is Madrid. The product is Madrid. The product is London.</td>
</tr>
<tr>
<td><strong>Replace</strong>: Madrid</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Split adapter

Uses a specified delimiter, for example, a space, to break a string into two or more strings. In **Output Pattern**, use $ to specify groups. $0 represents the entire input, $1 represents the first group, $2 represents the second group, and so on. You can repeat a group in an output pattern, for example, $2, $1, $1. Multiple instances of a delimiter in source data create three or more groups.
Parameter examples

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delimiter: &quot; &quot;</td>
<td>John Smith</td>
<td>Smith, John</td>
</tr>
<tr>
<td>Output Pattern: $2, $1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delimiter: &quot; &quot;</td>
<td>John Harry Smith</td>
<td>Harry, John, John</td>
</tr>
<tr>
<td>Output Pattern: $2, $1, $1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delimiter: &quot; &quot;</td>
<td>John Harry Smith</td>
<td>Smith</td>
</tr>
<tr>
<td>Output Pattern: $3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Task Number adapter

Adds a prefix or suffix to a task number or replaces the task number's prefix.

Parameter examples

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modification: Replace</td>
<td>PRB80899</td>
<td>STRY80899</td>
</tr>
<tr>
<td>Number Prefix: PRB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Number Prefix: STRY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modification: Add Prefix</td>
<td>08099</td>
<td>STRY80899</td>
</tr>
<tr>
<td>Prefix: STRY</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Time Zone Conversion adapter

Converts one time zone to another.

Parameter example

<table>
<thead>
<tr>
<th>Parameter and value</th>
<th>Source data</th>
<th>Adapter output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output time zone: PDT</td>
<td>07:00:00 am GMT</td>
<td>00:00:00 am PDT</td>
</tr>
</tbody>
</table>

Instance Data Replication (IDR) and blacklisted tables blacklisted tables

Some tables cannot be included in replication sets. Child tables of blacklisted tables are also blacklisted.
Blacklisted tables

- Tables with the prefixes V_PREFIX, SYSX_, sys, ts_, ua_, usageanalytics_, wf_, ecc_, clone_, jrobin_, rrd_, imp_, pf_, pfld_, idr_
- There are a few exceptions, for example, sys_domain.
- Rotated tables, including syslog, sys_querystat, ecc_queue, ecc_event, cmdb_metric, sysevent
- Tables without a sys_id
- sso_federation
- saml2_update1_properties
- sso_properties
- digest_properties
- Instance

IntegrationHub

Automate integration tasks using ServiceNow-built components for Flow Designer, or develop custom integrations. Requires a separate subscription.

Capabilities

IntegrationHub enables execution of third-party APIs as a part of a flow when a specific event occurs in ServiceNow. These integrations, referred to as spokes, are easy to configure and enable you to quickly add powerful actions without the need to write a script. For example, you can post a message and incident details in a Slack channel when a high priority incident is created.

IntegrationHub provides the following functionality:

Spokes for base system integrations

Using IntegrationHub actions in Flow Designer, you can:
- Post messages and ServiceNow incident, problem, and change record details to HipChat, Slack spoke, or Microsoft Teams spoke communications channels.
- Synchronize data across multiple production instances using the eBonding spoke as an example.

Create custom integrations

Build custom integrations with Action Designer using a REST step or a Script step.

Automate the administration of servers and applications in your network

Use custom actions to delegate Flow Designer processes to a MID Server in your network. For example, actions that use the PowerShell step or REST step.

Connection and Credentials

IntegrationHub takes advantage of aliases to manage connection information and credentials when integrating with external systems. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. IntegrationHub only requires an alias, which then resolves to use the correct credentials and connection information during runtime. Learn more about credentials, connections, and aliases.
Benefits

IntegrationHub provides process owners and developers these benefits.

- Consolidates multiple Now Platform automation capabilities into a single environment so process owners and developers can build and visualize business processes and integrations from a single interface.
- Extends Flow Designer content to integrate business processes with external systems.
- Promotes business process automation by enabling subject matter experts to develop and share spokes with flow designers.
- Provides natural-language-descriptions of integration logic to help non-technical users understand triggers, actions, inputs, and outputs.

Development process

When developing a custom integration, develop all actions for the integration within a scoped application. When deployed to a target instance, these actions are grouped as a spoke in Flow Designer. Brand the spoke by adding a custom icon to the application record. To learn more about application development, see Applications.

When developing spokes, flow and action designers typically perform these application development tasks.

1. Create a scoped application on a development instance to build spokes.
2. Publish a test version of the scoped application to the application repository.
3. Deploy the scoped application to a test instance from the application repository.
4. Test the scoped application on the test instance.
5. When working as expected, publish the scoped application in one of the following ways.
   - Publish to the application repository for deployment on production instances.
   - Publish to the ServiceNow Store as an application that customers can request for their environments.
   - Publish to ServiceNow Share to provide content to other customers in the ServiceNow community.

Review Flow Designer design considerations in the Architecture Overview.

Request IntegrationHub

IntegrationHub lets you build reusable integrations with third-party systems and call them from anywhere in the platform. For example, request IntegrationHub to call external systems using integration APIs from the Action Designer Script step, run the Script step on the Mid Server, and activate protocol steps like REST, SOAP, and PowerShell.

Flow Designer is a Now Platform feature that enables you to automate processes within a single ServiceNow instance. Without an IntegrationHub subscription, you can use base system actions or steps, including the Script step, to manipulate records, send emails, trigger notifications, and perform operations within the instance. Request IntegrationHub to automate and create integrations with external systems from the Flow Designer interface.
## IntegrationHub usage and subscription

Choose an IntegrationHub subscription package to build reusable integrations with third-party systems. Use the usage dashboard to view the number of transactions used within your current subscription, and to view transaction details.

### IntegrationHub subscription packages

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Starter</th>
<th>Standard</th>
<th>Professional</th>
<th>Enterprise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build your own integrations.</td>
<td>Automate developer operations.</td>
<td>Automate IT operations.</td>
<td>Automate human resources, customer relationship management, enterprise resource planning, and more.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maximum transactions per year</th>
<th>Starter package + 500,000</th>
<th>Starter package + 2,000,000</th>
<th>Starter package + 5,000,000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slack, Slack webhooks, ServiceNow eboning, Microsoft Teams, Twilio, HipChat, Zoom</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Spokes included</th>
<th>Starter package + Azure DevOps Boards, Jira, Jira V2.5, F5 BIG-IP, Jenkins, Docker, GitHub, Kubernetes, InfoBlox, Twitter</th>
<th>Standard package + Box, Google Drive, Google Tasks, Google Cloud Translator Service, Gmail, Microsoft Active Directory, Microsoft Azure Active Directory, Microsoft Exchange Online, Microsoft Exchange Server, Microsoft OneDrive, Microsoft SharePoint Online, Okta, Okta v1.1.1</th>
<th>Professional package + Adobe Experience Platform, Adobe Sign, Coupa, DocuSign, DocuSign v1.2, Microsoft Dynamics, Microsoft SCCM, Salesforce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocols included</td>
<td>SOAP step, REST step, Open API support</td>
<td>Starter package + JDBC step</td>
<td>Standard package + PowerShell step, SSH step</td>
</tr>
<tr>
<td>Entitlements included</td>
<td>None</td>
<td>None</td>
<td>Orchestration Activity Designer, Activity Packs, and all templates</td>
</tr>
<tr>
<td>Features included</td>
<td>Payload Builder step, Retry policies, Remote Tables</td>
<td>Starter package + XML Parser</td>
<td>Standard package</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
IntegrationHub usage overview

Navigate to **IntegrationHub > Usage Overview** to view the current transaction count for your instance.

Request an IntegrationHub plugin

IntegrationHub plugins require a separate subscription and must be activated by ServiceNow personnel. To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization's production and sub-production instances, generally within a few days.

If you do not have an account manager, decide to delay activation after purchase, or want to evaluate the product on a sub-production instance without charge, follow these steps.

1. Navigate to **System Applications > All Available Applications > All.**
2. On the All Applications page, click **Request Plugin** to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.

4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click Submit.

**IntegrationHub plugins**

Request IntegrationHub plugins included in your subscription.

**ServiceNow IntegrationHub plugins**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow IntegrationHub Starter Pack Installer [com.glide.hub.integrations]</td>
<td>Installs IntegrationHub starter pack plugins to build your own integrations. Includes HipChat spoke, MicrosoftTeams spoke, Slack spoke, Slack webhooks spoke, eBonding spoke, legacy IntegrationHub usage dashboard, and REST and SOAP steps.</td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Standard Pack Installer</td>
<td>Installs IntegrationHub standard pack plugins to automate developer operations. Includes IntegrationHub starter pack, and JDBC and XML parser steps.</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Professional Pack Installer</td>
<td>Installs IntegrationHub professional pack plugins to automate IT operations. Includes IntegrationHub standard pack, Microsoft AD spoke, Microsoft Azure AD spoke, and SSH and PowerShell steps.</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Enterprise Pack Installer</td>
<td>Installs IntegrationHub enterprise pack to automate human resources, customer relationship management, enterprise resource planning, and more. Includes IntegrationHub professional pack, Microsoft SCCM spoke, and Data Stream actions.</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Content - Deprecated</td>
<td>Flow Designer actions to integrate with Slack, HipChat, Microsoft AD, Microsoft Azure, Microsoft Teams, and ServiceNow eBonding</td>
</tr>
<tr>
<td>Flow Designer Action Step - Payload Builder</td>
<td>Enable action designers to easily create name-value pairs in JSON and XML payloads using dynamic data.</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Step - JDBC</td>
<td>Create a reusable action to send SQL commands to a relational database.</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Step - REST</td>
<td>Enables the REST action step in Flow Designer.</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Step - PowerShell</td>
<td>Enables the PowerShell action step in Flow Designer.</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Step - SOAP</td>
<td>Enables the SOAP action step in Flow Designer.</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Step - SSH</td>
<td>The SSH step executes SSH commands on an external *nix system through a ServiceNow® MID Server. The step also stores scripts and commands for the *nix systems.</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Step - XML Parser</td>
<td>Enables the XML parser action step in Flow Designer.</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Action Template - Data Stream</td>
<td>Send REST or SOAP requests from Flow Designer to APIs that return a stream of response data larger than 10 MB, or that return paginated results. Parse stream data into a series of complex object outputs and use the data pills in other actions in a flow.</td>
</tr>
<tr>
<td>HipChat Spoke for ServiceNow IntegrationHub</td>
<td>The HipChat Spoke for ServiceNow IntegrationHub provides actions that a Process Analyst can use when designing flows. The actions allow them to automate the creation of conversations, add users to a conversation, and send messages to a conversation.</td>
</tr>
<tr>
<td>Slack Spoke for ServiceNow IntegrationHub</td>
<td>The Slack Spoke for ServiceNow IntegrationHub provides actions that a Process Analyst can use when designing flows. Send messages about incidents and problems to a channel.</td>
</tr>
<tr>
<td>Slack Webhooks Spoke for ServiceNow IntegrationHub</td>
<td>Use Slack webhooks to post messages and record details for ServiceNow incidents, problems, and changes to Slack channels.</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft SCCM Spoke for IntegrationHub [com.sn.sccm.spoke]</td>
<td>Provides actions that a Process Analyst can use to automate the management of user collections, device collections, and application deployments.</td>
</tr>
<tr>
<td>Microsoft Teams Spoke for ServiceNow IntegrationHub [com.sn.ms_teams.ah]</td>
<td>The Microsoft Teams Spoke for ServiceNow IntegrationHub provides actions that a Process Analyst can use when designing flows to automate sending messages about Incidents and Problems to an MS Teams channel.</td>
</tr>
<tr>
<td>Microsoft AD Spoke for IntegrationHub [com.sn.ad.spoke]</td>
<td>Create, delete, and manage objects in Microsoft Active Directory, such as users, groups, and computers.</td>
</tr>
<tr>
<td>Microsoft Azure AD Spoke for IntegrationHub [com.sn.azure_ad.spoke]</td>
<td>Manage users, security groups, and office groups. Apply licenses and provision users in Office 365.</td>
</tr>
<tr>
<td>ServiceNow eBonding Spoke for ServiceNow IntegrationHub [com.glide.sn.ebonding.ah]</td>
<td>The ServiceNow ebonding Spoke for the ServiceNow IntegrationHub provides Actions that enable process analysts to compose flows that help in ebonding with remote ServiceNow instances.</td>
</tr>
</tbody>
</table>

### IntegrationHub available spokes

Review the integration-specific flows and actions available to each spoke.

Some third-party integrations are available on the ServiceNow Store. For more information, see the ServiceNow Store.

#### Spokes list and compatibility

<table>
<thead>
<tr>
<th>IntegrationHub subscription</th>
<th>Spoke name</th>
<th>Version</th>
<th>Tested against</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter</td>
<td>HipChat spoke</td>
<td>Introduced in Kingston</td>
<td>HipChat API version v2</td>
</tr>
<tr>
<td></td>
<td>ServiceNow eBonding spoke</td>
<td>Introduced in Kingston</td>
<td>ServiceNow API version v1</td>
</tr>
<tr>
<td></td>
<td>Slack spoke</td>
<td>Introduced in Madrid</td>
<td>Slack Web API</td>
</tr>
<tr>
<td></td>
<td>Slack webhooks spoke</td>
<td>Introduced in Kingston</td>
<td>Slack Incoming Webhooks</td>
</tr>
<tr>
<td></td>
<td>Twilio spoke v1.1.2</td>
<td>• 1.0.0</td>
<td>Twilio base version 2010-04-01, Twilio Messaging version v1, and Twilio Notify version v1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft Teams spoke</td>
<td>Introduced in Kingston</td>
<td>Microsoft teams API version v1</td>
</tr>
<tr>
<td></td>
<td>Microsoft Teams Graph spoke v3.3.0</td>
<td>• 1.0.0</td>
<td>Microsoft Graph REST API version v1.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Madrid</td>
<td></td>
</tr>
<tr>
<td>IntegrationHub subscription</td>
<td>Spoke name</td>
<td>Version</td>
<td>Tested against</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------</td>
<td>---------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td>#unique_1004</td>
<td>1.0.6</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Madrid</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• London</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Zoom spoke v1.6.0</td>
<td>1.0.2</td>
<td>Zoom API version v2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td>Standard</td>
<td>Azure DevOps Boards spoke v1.6.2</td>
<td>1.5.5</td>
<td>Azure DevOps Boards REST API version 4.1 and TFS 2018 Update 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Orlando</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.5.2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Orlando</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Docker spoke</td>
<td>1.0.1</td>
<td>Docker Community Edition version 18.09.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Madrid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>F5 BIG-IP spoke</td>
<td>1.0.2</td>
<td>BIG-IP version 13.1.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Madrid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>GitHub spoke</td>
<td>1.0.1</td>
<td>GitHub API version v3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Infoblox spoke v1.0.2</td>
<td>1.0.0</td>
<td>Infoblox versions 2.7 and 2.9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Madrid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Jenkins spoke</td>
<td>2.0.0</td>
<td>All Jenkins versions between 1.651.1 and 2.150.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Madrid</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.6.3</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• London</td>
<td></td>
</tr>
<tr>
<td>IntegrationHub subscription</td>
<td>Spoke name</td>
<td>Version</td>
<td>Tested against</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------</td>
<td>--------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td></td>
<td>Jira spoke</td>
<td>• 2.5.5</td>
<td>Jira API version v2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• • New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2.0.1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• • Madrid</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1.5.1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• • London</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Jira spoke v2.5.7</td>
<td>• 2.5.0</td>
<td>Jira API version v2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• • New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Kubernetes spoke</td>
<td>• 1.0.2</td>
<td>Kubernetes API version v1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• • New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• • Madrid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Twitter spoke</td>
<td>• 1.0.1</td>
<td>Twitter API version v1.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• • New York</td>
<td></td>
</tr>
<tr>
<td>Professional</td>
<td>Box spoke v2.0.4</td>
<td>• 2.0.0</td>
<td>Box API version v2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• • New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• • Madrid</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1.3.8</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• • London</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Google Cloud Translator</td>
<td>• 1.0.2</td>
<td>Google Translate API version v3beta1</td>
</tr>
<tr>
<td>Service Spoke</td>
<td></td>
<td>• • New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Google Drive spoke v1.2</td>
<td>• 1.0.1</td>
<td>REST API v3.0, Google Drive Open API</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• • New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Gmail spoke</td>
<td>• 1.0.1</td>
<td>Gmail API v1.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• • New York</td>
<td></td>
</tr>
<tr>
<td>IntegrationHub subscription</td>
<td>Spoke name</td>
<td>Version</td>
<td>Tested against</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------</td>
<td>--------------------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Google Tasks spoke</td>
<td>• 1.0.1</td>
<td>Google Tasks API v1.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Google Cloud Translator Service Spoke</td>
<td>Introduced in New York</td>
<td>Google Translate API v3beta1</td>
</tr>
<tr>
<td></td>
<td>Microsoft AD spoke</td>
<td>Introduced in London</td>
<td>Powershell version 5.0, Microsoft AD 2016</td>
</tr>
<tr>
<td></td>
<td>Microsoft Azure AD spoke</td>
<td>Introduced in London</td>
<td>Microsoft Azure API v1</td>
</tr>
<tr>
<td></td>
<td>Microsoft Exchange Online spoke v1.2.0</td>
<td>• 1.0.0</td>
<td>Microsoft Graph REST API v1.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft Exchange Server spoke v1.7</td>
<td>• 1.0.3</td>
<td>Exchange Server 2013 and 2016 installed on Windows Server 2012 R2 and 2016</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft OneDrive spoke v1.5.2</td>
<td>• 1.0.0</td>
<td>Microsoft Graph API 1.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Madrid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft SharePoint spoke v1.1.2</td>
<td>• 1.1.2</td>
<td>Microsoft SharePoint Online API version v1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Paris</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Orlando</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Madrid</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1.0.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Orlando</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1.0.2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Madrid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Okta spoke</td>
<td>• 1.0.0</td>
<td>Okta API version v1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Madrid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Okta spoke v1.1.1</td>
<td>• 1.1.1</td>
<td>Okta API version v1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New York</td>
<td></td>
</tr>
<tr>
<td>IntegrationHub subscription</td>
<td>Spoke name</td>
<td>Version</td>
<td>Tested against</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Enterprise</td>
<td>Adobe Experience Platform spoke</td>
<td>1.0.0</td>
<td>Adobe Experience Platform released on September 10, 2019</td>
</tr>
<tr>
<td></td>
<td>#unique_1030</td>
<td>1.0.2</td>
<td>Adobe Sign API version v6</td>
</tr>
<tr>
<td></td>
<td>Coupa spoke v3.0.1</td>
<td>2.0.0</td>
<td>Coupa version stable_025.6.0</td>
</tr>
<tr>
<td></td>
<td>DocuSign spoke v1.1.6</td>
<td>1.1.4</td>
<td>DocuSign API version v2</td>
</tr>
<tr>
<td></td>
<td>DocuSign spoke v1.2.2</td>
<td>1.2.0</td>
<td>DocuSign API version v2 or v2.1</td>
</tr>
<tr>
<td></td>
<td>First Advantage spoke v1.0.1</td>
<td>1.0.1</td>
<td>First Advantage API version v1.1</td>
</tr>
<tr>
<td></td>
<td>Microsoft Dynamics CRM spoke v1.0.1</td>
<td>1.0.0</td>
<td>Microsoft Dynamics API v9</td>
</tr>
<tr>
<td></td>
<td>Microsoft SCCM spoke</td>
<td>Introduced in Madrid</td>
<td>Microsoft SCCM version 1802</td>
</tr>
<tr>
<td></td>
<td>#unique_1037</td>
<td>1.0.1</td>
<td>Salesforce API version v45.0</td>
</tr>
</tbody>
</table>

**Note:** Because the eBonding Example spoke includes sample actions to demonstrate integrating with a remote instance, it does not require a subscription package.

### Adobe Experience Platform spoke

Automate the process of managing datasets and entities in Adobe Experience Platform from your ServiceNow instance.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions

This spoke was built for Adobe Experience Platform released on September 10, 2019, but may be compatible with later versions.

Spoke requirements

- Registered Adobe ID account
- User with developer access
- Details such as API key and client secret

See the Adobe Experience Platform documentation for instructions on creating Adobe ID and adding developer.

Spoke actions

The Adobe Experience Platform spoke provides actions manage datasets and entities when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataset Management</td>
<td>Get All Data Inlets</td>
<td>Retrieves the details of all data inlets.</td>
</tr>
<tr>
<td></td>
<td>Get All Datasets</td>
<td>Retrieves the details of all datasets.</td>
</tr>
<tr>
<td></td>
<td>Get All Union Schemas</td>
<td>Retrieves the list of all schemas that are part of unions.</td>
</tr>
<tr>
<td>Entity Management</td>
<td>Get Entity Information</td>
<td>Retrieves the information of an entity.</td>
</tr>
<tr>
<td></td>
<td>Load Entity Data</td>
<td>Ingest the information of an entity to Adobe Experience Platform.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Metadata For All Attributes In A Schema</td>
<td>Retrieves all attributes for the selected union schema.</td>
</tr>
<tr>
<td></td>
<td>Get Metadata For All Data Inlets</td>
<td>Retrieves the metadata of all data inlets.</td>
</tr>
</tbody>
</table>
## Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see [Credentials and connection information](#).

**Note:** Two connection and credential alias records are needed for the Adobe Experience Platform spoke; one for data inlet management and batch ingestion, and other for data collection. Each alias should be associated with the respective Adobe Experience Platform API.

## Set up Adobe Experience Platform spoke

Integrate your Adobe Experience Platform account with your ServiceNow instance. Create a custom OAuth application in Adobe Experience Platform and authenticate requests from ServiceNow.

- Request IntegrationHub subscription
- Activate Adobe Experience Platform spoke
- Role required: admin

### Attach a Java Key Store certificate to the Adobe Experience Platform spoke

Enable the JWT Bearer Grant token authentication by attaching a valid Java KeyStore (JKS) certificate to the Adobe Experience Platform spoke.

- Valid Java KeyStore certificate
- Role required: admin

1. Navigate to **System Definition > Certificates**.
2. Click **New**.
3. On the form, fill in the fields.

#### X.509 Certificate form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, AEP Certificate.</td>
</tr>
<tr>
<td>Expiration notification</td>
<td>Option to send a notification when the certificate is about to expire.</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify on expiration</td>
<td>Users to be notified when the certificate expires.</td>
</tr>
<tr>
<td>Warn in days to expire</td>
<td>Number of days to send a notification before the certificate expires.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the certificate.</td>
</tr>
<tr>
<td>Format</td>
<td>Certificate format. The instance supports the PEM and DER formats.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of certificate. Select <strong>Java Key Store</strong>.</td>
</tr>
<tr>
<td>Valid from</td>
<td>Date from which the certificate is valid.</td>
</tr>
<tr>
<td>Expires</td>
<td>Date on which the certificate expires.</td>
</tr>
<tr>
<td>Expires in days</td>
<td>Number of days until the certificate expires.</td>
</tr>
<tr>
<td>Key store password</td>
<td>Password associated with the certificate.</td>
</tr>
<tr>
<td>Short description</td>
<td>Summary about the certificate.</td>
</tr>
<tr>
<td>PEM Certificate</td>
<td>Contents of the X509 certificate.</td>
</tr>
</tbody>
</table>

4. Click the attachments icon ( ![Attachment Icon](attachment_icon.png) ) and attach a JKS certificate.

5. Click **Validate Stores/Certificates**.

The JKS certificate is created and attached to the Adobe Experience Platform spoke.

*Create a JWT signing key for the Adobe Experience Platform spoke*

Create a JSON Web Token (JWT) signing key to assign to your Java KeyStore certificate.

Role required: admin

1. Navigate to **System OAuth > JWT Keys**.
2. Click **New**.
3. On the form, fill in the fields.

#### JWT Keys form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the JWT signing key. For example, AEP JWT Keys.</td>
</tr>
<tr>
<td>Signing Keystore</td>
<td>Valid JKS certificate attached in the previous task. For example, AEP Certificate.</td>
</tr>
<tr>
<td>Key Id</td>
<td>Key ID to identify which key is used when multiple keys are used to sign tokens.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope which contains this record. Select Adobe Experience Platform spoke.</td>
</tr>
<tr>
<td>Signing Algorithm</td>
<td>Algorithm to sign with the JWT key.</td>
</tr>
<tr>
<td>Signing Key Password</td>
<td>Password associated with the signing key.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the certificate.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

The JWT key is created and assigned to the JKS certificate.
Create a JWT provider for the Adobe Experience Platform spoke
Add a JSON Web Token (JWT) provider to your ServiceNow instance.

Role required: admin

1. Navigate to System OAuth > JWT Providers.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the JWT provider. For example, AEP JWT Provider.</td>
</tr>
<tr>
<td>Expiry Interval (sec)</td>
<td>Number in seconds to set the lifespan of JWT provider tokens.</td>
</tr>
<tr>
<td>Signing Configuration</td>
<td>JWT signing key from the previous step. For example, AEP JWT Keys.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click Save.
   The Standard Claims and Custom Claims related lists are displayed.
5. Enter values for iss, sub, and aud in the Standard Claims related list. See the Adobe Experience Platform documentation documentation for instructions.
6. Enter these values in the Custom Claims related list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Claim Name</td>
<td><a href="https://ims-na1.adobelogin.com/s/entdataservices_sdk">https://ims-na1.adobelogin.com/s/entdataservices_sdk</a></td>
</tr>
<tr>
<td>Claim Value Type</td>
<td>true</td>
</tr>
<tr>
<td>Claim Value</td>
<td>true</td>
</tr>
</tbody>
</table>

7. Click Update.

The JWT provider is added to your ServiceNow instance.

Register Adobe Experience Platform as OAuth Provider
Use the information generated during Adobe ID account creation and configuration to register Adobe Experience Platform as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Role required: admin

1. Navigate to System OAuth > Application Registry.
2. Click New.
   The system displays the message What kind of OAuth application?
3. Select Connect to a third party OAuth Provider.
   The system displays a blank Application Registries form.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter AEP OAuth.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Consumer key you generated during the Adobe ID account configuration.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Consumer secret you generated during the Adobe ID account configuration.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Script to customize the request and response. Select OAuthUtilAEP.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Grant type used to establish the token. Select JWT Bearer.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record. Select Adobe Experience Platform.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>This field should be left blank.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>This field should be left blank.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>This field should be left blank.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. This option requires a mutual authentication profile to be specified.</td>
</tr>
<tr>
<td>Send Credentials</td>
<td>Client credentials in the request.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click Save.
   - The system validates the OAuth credentials and populates the Redirect URL.
   - The system populates OAuth Entity Profile with Grant Type as JWT Bearer. For example, OAuth Entity Profile is created with default Name, AEP default_profile

6. Open the record of OAuth Entity Profile.
7. Select the JWT Provider record for JWT Provider. For example, AEP JWT Provider.
8. Click Update.

The instance can request OAuth 2.0 tokens for the spoke.

Note: When an OAuth token expires, the spoke automatically regenerates a new token in most cases. If a token expires and is not regenerated, an administrator can regenerate the spoke OAuth token.
Create Credential records for the Adobe Experience Platform
Create Credential records to the Adobe ID account you created. The Adobe Experience Platform spoke connection and credential alias uses these credentials to authorize actions.

Role required: admin
You must create two credential records; one for data inlet management and batch ingestion, and other for data collection.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
The system displays the message What type of Credentials would you like to create?.
3. Select OAuth 2.0 Credentials.
The pop-up window displays a blank OAuth 2.0 Credentials form.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter AEP for data inlet management and batch ingestion, and AEP_Ingestion for data collection.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile you created when you registered the Salesforce connected app as an OAuth provider. For example, select AEP OAuth default_profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>This field isn't applicable.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Save the record.
6. Click the Get OAuth Token related link to generate the OAuth token.

The credential records for the Adobe Experience Platform spoke is created.

Create Connection records for the Adobe Experience Platform spoke
Create Connection records to your Adobe ID account. The Adobe Experience Platform spoke connection and credential alias uses these connections to perform actions in Adobe Experience Platform.

Role required: admin
Two connection and credential alias records are available by default; one for data inlet management and batch ingestion, and other for data collection. Perform these steps to associate each alias with the respective Adobe Experience Platform API.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the required Adobe Experience Platform spoke record.

Note: There are two connection and credential records; AEP and AEP_Ingestion. The AEP record is for data inlet management and batch ingestion, and AEP_Ingestion is for data collection.

3. From the Connections tab, click New.
The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter AEP Platform for data inlet management and batch ingestion, and AEP dcs for data collection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Adobe Experience Platform. For example, select AEP and AEP_Ingestion.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Note: Do not select the check box.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to Adobe Experience Platform.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for data inlet management and batch ingestion, enter <a href="https://platform.adobe.io/">https://platform.adobe.io/</a>.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for data collection, enter <a href="https://dcs.adobedc.net">https://dcs.adobedc.net</a>.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>This field isn't applicable.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. In the Attributes related list, enter these values.

- If the connection record is for data inlet management and batch ingestion, enter API Key and Organization ID.
- If the connection record is for data collection, enter Organization ID.

6. Right-click the form header and click Save.

The Adobe Experience Platform spoke is set up and integrated with the ServiceNow instance.

**Azure DevOps Boards spoke v1.6.2**

Automate the process of managing work items in Azure DevOps Boards from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.
Supported versions

This spoke was built for Azure DevOps Boards REST API version 4.1 and TFS 2018 Update 3, but may be compatible with later versions.

Spoke requirements

- Azure DevOps instance
- Personal access tokens (PATs) to authenticate Azure DevOps

See Azure DevOps documentation for information about creating personal access token.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Note: Some of these plugins are licensable features and require appropriate licenses, if used outside the spoke implementation.

Spoke actions

The Azure DevOps Boards spoke provides actions manage work items when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core Process Management</td>
<td>Create Iteration</td>
<td>Creates an Azure DevOps iteration.</td>
</tr>
<tr>
<td></td>
<td>Delete Iteration</td>
<td>Deletes an Azure DevOps iteration by path.</td>
</tr>
<tr>
<td></td>
<td>Post Iteration to Team</td>
<td>Adds an Azure DevOps iteration to an Azure DevOps team.</td>
</tr>
<tr>
<td></td>
<td>Reporting Work Items Revisions</td>
<td>Adds reporting work-item revisions for batch processing.</td>
</tr>
<tr>
<td></td>
<td>Reporting Work Items Links</td>
<td>Adds reporting work-item links for batch processing.</td>
</tr>
<tr>
<td></td>
<td>Update Iteration</td>
<td>Updates the name, start date, and end date for an Azure DevOps iteration.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Delink Iterations From A Team</td>
<td>Delinks Azure DevOps iterations from a team.</td>
</tr>
<tr>
<td></td>
<td>Get Creatable Fields</td>
<td>Retrieves the list of all fields in a required Azure DevOps project.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Area Paths of a Team</td>
<td>Retrieves the details of all area paths related to a team.</td>
</tr>
<tr>
<td></td>
<td>Get Areas Path</td>
<td>Retrieves the details of all area paths in a project.</td>
</tr>
<tr>
<td></td>
<td>Get Backlog and Default Iterations</td>
<td>Retrieves the details of all backlog and default iterations related to a team.</td>
</tr>
<tr>
<td></td>
<td>Get Iteration Paths</td>
<td>Retrieves the details of all iteration paths in a project.</td>
</tr>
<tr>
<td></td>
<td>Get Iteration by Path</td>
<td>Retrieves an Azure DevOps iteration with the specified path.</td>
</tr>
<tr>
<td></td>
<td>Get Iteration Paths of a Team</td>
<td>Retrieves the details of all iteration paths of a team.</td>
</tr>
<tr>
<td></td>
<td>Get Teams</td>
<td>Retrieves the details of all teams in a project.</td>
</tr>
<tr>
<td></td>
<td>Get Processes</td>
<td>Retrieves the details of all processes.</td>
</tr>
<tr>
<td></td>
<td>Get Work Item Data By ID</td>
<td>Retrieves details of the required work item.</td>
</tr>
<tr>
<td></td>
<td>Get Editable Fields</td>
<td>Retrieves the list of all fields in a required Work Item for editing.</td>
</tr>
<tr>
<td></td>
<td>Get Projects</td>
<td>Retrieves the list of all Azure DevOps projects.</td>
</tr>
<tr>
<td></td>
<td>Get Work Item Relations</td>
<td>Retrieves all relations of a required Work Item.</td>
</tr>
<tr>
<td></td>
<td>Get Work Item Type Fields By Process</td>
<td>Retrieves the list of all Work Item Type fields in a required Azure DevOps process.</td>
</tr>
<tr>
<td></td>
<td>Get Work Item Types By Process</td>
<td>Retrieves the list of all Work Item types in a required Azure DevOps process.</td>
</tr>
<tr>
<td></td>
<td>Get Work Item Types</td>
<td>Retrieves the list of all Work Item types in a required Azure DevOps project.</td>
</tr>
<tr>
<td>Work Item Management</td>
<td>Create Child Link</td>
<td>Creates parent-child relationships between the required Work Items.</td>
</tr>
<tr>
<td></td>
<td>Create Work Item</td>
<td>Creates a Work Item in your Azure DevOps instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Work Item</td>
<td>Deletes the required Work Item in your Azure DevOps instance.</td>
</tr>
<tr>
<td></td>
<td>Delink Work Items</td>
<td>Delinks parent-child relationships between the required Work Items.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Update Work Item</td>
<td>Updates details of the required Work Item.</td>
</tr>
<tr>
<td></td>
<td>Add Attachment</td>
<td>Adds an attachment associated with a ServiceNow record to the required work item on the Azure DevOps instance.</td>
</tr>
<tr>
<td></td>
<td>Move To Project</td>
<td>Moves between projects in the same organization.</td>
</tr>
<tr>
<td></td>
<td>Register Service Hook</td>
<td>Registers webhooks for the required project.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Credentials and connection information](#).

**Set up Azure DevOps Boards spoke**

Integrate the ServiceNow instance and Azure DevOps Boards using basic authentication to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Activate Azure DevOps Boards spoke
- Role required: admin

_Create Credential records for the Azure DevOps Boards spoke_

Create Credential records for the Azure DevOps instance. The Azure DevOps Boards spoke connection and credential alias uses these credentials to authorize actions.

1. Navigate to Connections & Credentials > Credentials.
2. Click **New**.
   The system displays the message What type of Credentials would you like to create?.
3. Select **Basic Auth Credentials**.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Azure DevOps Boards Credentials.</td>
</tr>
<tr>
<td>User name</td>
<td>User name to log in to your Azure DevOps instance.</td>
</tr>
<tr>
<td>Password</td>
<td>Personal access token to authenticate Azure DevOps.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>
5. Click **Submit**.

*Create Connection records for the Azure DevOps Boards spoke*

Create Connection records to your Azure DevOps instance. The Azure DevOps Boards spoke connection and credential alias uses these connections to perform actions in the Azure DevOps instance.

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the record for **Azure DevOps Boards**.
3. From the **Connections** tab, click **New**.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter <em>Azure DevOps Boards Connection</em>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Azure DevOps Boards. For example, select <em>Azure DevOps Boards Credentials</em>.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>URL of the Azure DevOps instance. For example, <a href="https://dev.azure.com/">https://dev.azure.com/</a>&lt;instance-name&gt;.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Box spoke v2.0.4**

Move attachments to Box where they can be managed as shared documents.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Supported versions**

API version v2.

**Spoke flows**

The Box spoke provides sample flows in the draft state to demonstrate automating Box tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:
## Spoke actions

The Box spoke provides actions to automate Box tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Management</td>
<td>Add Metadata to File</td>
<td>Specifies custom data for a particular file or folder.</td>
</tr>
<tr>
<td></td>
<td>Attach Box File to Record</td>
<td>Copies a file from Box and attaches it to the specified ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Lookup File ID</td>
<td>Retrieves the ID of the specified file in Box.</td>
</tr>
<tr>
<td></td>
<td>Move Owned Item</td>
<td>Moves all items owned by the specified user in Box to the specified folder.</td>
</tr>
<tr>
<td></td>
<td>Remove File</td>
<td>Removes the specified file from Box.</td>
</tr>
<tr>
<td></td>
<td>Search Content</td>
<td>Searches for files, folders, web links, and shared files across the users content or across the entire enterprise.</td>
</tr>
<tr>
<td></td>
<td>Upload File</td>
<td>Uploads the specified file to Box.</td>
</tr>
<tr>
<td>Document Sharing</td>
<td>Add Collaborator</td>
<td>Grants a user or group a specified level of access to a particular file or folder. Collaborators have one of these access levels.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Co-Owner</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Previewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Preview Uploader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Uploader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Viewer Uploader</td>
</tr>
<tr>
<td></td>
<td>Create Shared Link</td>
<td>Create a direct and read-only link to a file or folder in Box.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look up Folder Collaborators By ID</td>
<td>Retrieves all the collaborators associated to the specified folder ID.</td>
</tr>
<tr>
<td></td>
<td>Remove Collaborator</td>
<td>Removes the specified collaboration from a file or folder in Box.</td>
</tr>
<tr>
<td>Folder Management</td>
<td>Create Folder</td>
<td>Creates a folder in Box on behalf of the specified Box user account.</td>
</tr>
<tr>
<td></td>
<td>Delete Folder</td>
<td>Deletes the specified folder in Box.</td>
</tr>
<tr>
<td></td>
<td>Lookup Folder ID</td>
<td>Retrieves the ID of the specified folder in Box.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Items added to Box require ten minutes to become accessible.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, if one action creates a folder, a Lookup Folder ID action will not return results</td>
</tr>
<tr>
<td></td>
<td></td>
<td>until after ten minutes have passed.</td>
</tr>
<tr>
<td>Group Management</td>
<td>Create Group</td>
<td>Creates a group in Box with the specified invitation preferences.</td>
</tr>
<tr>
<td></td>
<td>Delete Group</td>
<td>Deletes the specified group in Box.</td>
</tr>
<tr>
<td></td>
<td>Update Group</td>
<td>Updates the specified group in Box with the specified preferences.</td>
</tr>
<tr>
<td>Legal Hold Management</td>
<td>Assign Legal Hold Policy</td>
<td>Assigns a legal hold policy to a file, file version, folder, or user.</td>
</tr>
<tr>
<td></td>
<td>Create Legal Hold Policy</td>
<td>Creates a legal hold policy.</td>
</tr>
<tr>
<td></td>
<td>Look up All Legal Hold Policies</td>
<td>Retrieves a list of legal hold policies of an enterprise.</td>
</tr>
<tr>
<td></td>
<td>Look up Legal Hold Policy Assignment by ID</td>
<td>Retrieves a legal hold policy assignment for the specified ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Legal Hold Policy Assignments</td>
<td>Retrieves a list of items assigned to a legal hold policy.</td>
</tr>
<tr>
<td></td>
<td>Look up Legal Hold Policy by ID</td>
<td>Retrieves a legal hold policy for the specified ID.</td>
</tr>
<tr>
<td></td>
<td>Remove legal hold policy</td>
<td>Deletes an existing legal hold policy.</td>
</tr>
<tr>
<td></td>
<td>Unassign Legal Hold Policy</td>
<td>Removes the assignment of an item to a legal hold.</td>
</tr>
<tr>
<td></td>
<td>Update Legal Hold Policy</td>
<td>Updates a legal hold policy.</td>
</tr>
<tr>
<td>Metadata Management</td>
<td>Get Metadata Instance on File</td>
<td>Retrieves the meta data instance of a file.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Get Metadata Instance on Folder</td>
<td>Retrieves the meta data instance of a folder.</td>
<td></td>
</tr>
<tr>
<td>Look up Metadata Instance on File</td>
<td>Retrieves all the meta data of a file.</td>
<td></td>
</tr>
<tr>
<td>Look up Metadata Instance on Folder</td>
<td>Retrieves all the meta data of a folder.</td>
<td></td>
</tr>
<tr>
<td>Query Files or Folders by Metadata</td>
<td>Searches for files or folders using SQL-like syntax and returns the matching results.</td>
<td></td>
</tr>
<tr>
<td>Retention Policy Management</td>
<td>Assign Retention Policy</td>
<td>Assigns a retention policy to an item.</td>
</tr>
<tr>
<td>Assigns a retention policy to an item.</td>
<td>Creates a retention policy.</td>
<td></td>
</tr>
<tr>
<td>Look up Retention Policies</td>
<td>Retrieves all the retention policies of an enterprise.</td>
<td></td>
</tr>
<tr>
<td>Look up Retention Policy Assignment By ID</td>
<td>Retrieves the retention policy with the specified ID.</td>
<td></td>
</tr>
<tr>
<td>Look up Retention Policy Assignments</td>
<td>Returns a list of all retention policy assignments associated with a specified retention policy.</td>
<td></td>
</tr>
<tr>
<td>Look up Retention Policy by ID</td>
<td>Retrieves the retention policy with the specified ID.</td>
<td></td>
</tr>
<tr>
<td>Update Retention Policy</td>
<td>Updates a retention policy.</td>
<td></td>
</tr>
<tr>
<td>User Management</td>
<td>Add User to Group</td>
<td>Adds the specified user to the specified group in Box.</td>
</tr>
<tr>
<td>Create User</td>
<td>Creates a new user account in Box.</td>
<td></td>
</tr>
<tr>
<td>Delete User</td>
<td>Deletes the specified user in Box.</td>
<td></td>
</tr>
<tr>
<td>Disable User</td>
<td>Sets the status of the specified user in Box to inactive.</td>
<td></td>
</tr>
<tr>
<td>Enable User</td>
<td>sets the status of the specified user in Box to active.</td>
<td></td>
</tr>
<tr>
<td>Lookup User ID</td>
<td>Retrieves the ID of the specified user in Box.</td>
<td></td>
</tr>
<tr>
<td>Update User</td>
<td>Updates the specified user in Box with the specified role changes.</td>
<td></td>
</tr>
<tr>
<td>Webhook Management</td>
<td>Create Webhook</td>
<td>Creates a webhook.</td>
</tr>
<tr>
<td>Look up Webhook By ID</td>
<td>Retrieves the webhook with the specified ID.</td>
<td></td>
</tr>
<tr>
<td>Look up Webhooks</td>
<td>Retrieves all the defined webhooks for the specified application.</td>
<td></td>
</tr>
<tr>
<td>Remove Webhook</td>
<td>Removes a webhook.</td>
<td></td>
</tr>
</tbody>
</table>
### Box account requirements

The Box spoke requires creating a custom app on your Box account to generate OAuth 2.0 tokens. See [Configure Box account](#).

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see [Credentials and connection information](#).

This spoke uses these alias records to authorize actions.

<table>
<thead>
<tr>
<th>Connection &amp; Credential alias</th>
<th>Description</th>
<th>Connection alias requirements</th>
</tr>
</thead>
</table>
| Box                          | Connection to the Box Collaboration and File Management APIs. | • Connection type: HTTP  
  • Connection URL: https://api.box.com |
| Box Upload                   | Connection to the Box upload service. | • Connection type: HTTP  
  • Connection URL: https://upload.box.com |

To use the spoke connection aliases, create an associated Connection record and an associated Credential record for each alias.

### Set up Box spoke

Integrate the ServiceNow instance and Box by creating a custom OAuth application in Box to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Activate the Box spoke
- Role required: admin

**Configure Box account**

Create a custom OAuth application from your Box account to enable OAuth 2.0 authentication with the Box spoke.

**Box requirements:**

- Box account
- Box administrator credentials

Complete these steps from your Box account. See the Box Developer Portal documentation for instructions on creating and configuring custom applications.

1. From your Box account, create a custom OAuth application.
2. Select standard OAuth 2.0 user authentication as the application authentication method.
3. Record the application client ID and client secret to register the app as a third-party OAuth provider on your ServiceNow instance.
4. Enable the matching Box application scope permissions you want the app to support.

<table>
<thead>
<tr>
<th>Box application scope permission</th>
<th>Required for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read and write all files and folders stored in Box</td>
<td>Document management, document sharing, and folder management actions</td>
</tr>
<tr>
<td>Manage users</td>
<td>User management actions</td>
</tr>
<tr>
<td>Manage groups</td>
<td>Group management actions</td>
</tr>
<tr>
<td>Manage enterprise properties</td>
<td>Document sharing, group management, and user management actions</td>
</tr>
</tbody>
</table>

Register Box as OAuth provider
Use the information generated during Box account configuration to register Box as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

1. Navigate to System OAuth > Application Registry.
2. Click New.
The system displays the message What kind of OAuth application?
3. Select Connect to a third party OAuth Provider.
The system displays a blank Application Registries form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Box OAuth.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the Client ID you created during the Box account configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret you created during the Box account configuration.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select Authorization Code.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click Save.
The system validates the OAuth credentials and populates the Redirect URL and the OAuth Entity Profiles related list.
6. Copy the value from Redirect URL.
7. Login to your Box account to edit the configuration of your custom Box application.
   See the Box Developer Documentation for instructions.
8. Paste the Redirect URL value into the OAuth 2.0 Redirect URI for your custom Box application.
   For example, paste https://instance.service-now.com/oauth_redirect.do.

The instance can request OAuth 2.0 tokens for the spoke.
Create Credential records for the Box spoke

Create Credential records to the Box custom OAuth application you created during Box account configuration. The Box spoke connection and credential aliases use these credentials to authorize actions.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   - The system displays the message What type of Credentials would you like to create?.
3. Select OAuth 2.0 Credentials.
   - The pop-up window displays a blank OAuth 2.0 Credentials form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Box API Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom Box application as an OAuth provider. For example, select Box OAuth default profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click Submit.
6. Click New.
   - The system displays the message What type of Credentials would you like to create?.
7. Select OAuth 2.0 Credentials.
   - The pop-up window displays a blank OAuth 2.0 Credentials form.
8. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Box Upload Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom Box application as an OAuth provider. For example, select Box OAuth default profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

9. Click Submit.
Create Connection records for the Box spoke
Create Connection records to your Box account and the Box APIs. The Box spoke connection and credential aliases use these connections to perform actions on Box.

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open for the record for **Box**.
3. From the **Connections** tab, click **New**.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Box API Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for the Box API. For example, select Box API Credentials.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
6. Open for the record for **Box Upload**.
7. From the **Connections** tab, click **New**.
   The system displays a blank HTTP(s) Connection form.
8. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Box Upload Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Box upload. For example, select Box Upload Credentials.</td>
</tr>
</tbody>
</table>

9. Click **Submit**.

Regenerate Box OAuth token
Regenerate the Box OAuth token when it expires. The Box spoke OAuth token expires every thirty days.

1. Navigate to **Connections & Credentials > Credentials**.
2. Select the Box spoke OAuth Credential record.
   For example, select **Box API Credentials**.
3. From Related Links, click **Get OAuth Token**.

The Box spoke receives a new OAuth access token good for 30 days.

**Coupa spoke v3.0.1**

Manage business spend and automate approval, contract, inventory, purchase order, requisition, supplier, and user management in Coupa from your ServiceNow instance.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Supported versions

This spoke was built for Coupa version stable_029.0.1, but may be compatible with later versions.

Spoke requirements

Create an API key in your Coupa instance and record the API key for later use. See Coupa documentation for information about creating API key.

Spoke user roles

The following user roles are available with the spoke:

- Coupa Admin (sn_coupa_spoke.Coupa Admin): Users with this role have access to both, My Current Approvals and Contracts modules.
- Coupa Approval User (sn_coupa_spoke.Coupa Approval User): Users with this role have access only to the My Current Approvals module
- Coupa Contract User (sn_coupa_spoke.Coupa Contract User): Users with this role have access only to the Contracts module.

Spoke module

The Coupa spoke adds a Coupa application to your ServiceNow instance. The Coupa application supports Coupa Approval User and Coupa Contract User roles. You can access the Coupa application from the ServiceNow instance on your Now Mobile app.

Note: Make sure that Coupa Login attribute and the user ID of ServiceNow instance match before using the My Current Approvals module.

The Coupa application has the following modules.

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Current Approvals</td>
<td>Displays the list of approvals in Coupa for a user.</td>
</tr>
<tr>
<td>Contracts</td>
<td>Displays a list of contracts in Coupa.</td>
</tr>
</tbody>
</table>
## Spoke actions

The Coupa spoke provides actions to automate approval, contract, inventory, invoice, catalog item, purchase order, requisition, supplier, and user management when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Management</td>
<td>Approve Approval Request</td>
<td>Approves an approval request in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Get Approval Details</td>
<td>Retrieves the details of the required approval in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Look Up Approval</td>
<td>Looks up an approval record in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Look Up Approval By Requisition ID</td>
<td>Looks up the required approval record in Coupa using its Requisition ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Approvals</td>
<td>Looks up the required approval records in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Reject Approval Request</td>
<td>Rejects a request for approval in Coupa.</td>
</tr>
<tr>
<td>Contract Management</td>
<td>Look Up Contracts</td>
<td>Looks up the required contract records in Coupa using the Coupa query.</td>
</tr>
<tr>
<td>Inventory Management</td>
<td>Create Receipt</td>
<td>Creates a receipt in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Get Receipt Details</td>
<td>Retrieves the details of the required receipt in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Get Receipt Fields</td>
<td>Retrieves the list of fields in the Coupa Receipts table.</td>
</tr>
<tr>
<td></td>
<td>Get Advance Shipment Notices After Updated Date</td>
<td>Retrieves the details of the advance shipment notices after the updated date in Coupa.</td>
</tr>
</tbody>
</table>

**Note:** Ensure that description has the exact item name. When you want to access the item name in a flow, use the description data pill.

**Note:** This is a metadata action and doesn’t make an API call to Coupa.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Look Up Advance Shipment Notice</td>
<td>Retrieves details of the required advance shipment notice using its Purchase Order Line ID.</td>
</tr>
<tr>
<td></td>
<td>By Purchase Order Line ID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Look Up Receipt</td>
<td>Looks up the required receipt in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Look Up Receipts</td>
<td>Looks up the required receipts in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Void Receipt</td>
<td>Makes the required receipt void.</td>
</tr>
<tr>
<td>Invoice Management</td>
<td>Look Up Invoice</td>
<td>Looks up an invoice in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Void Invoice</td>
<td>Makes the required invoice void.</td>
</tr>
<tr>
<td>Item Management</td>
<td>Look Up Items</td>
<td>Looks up the required items in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Look up Item</td>
<td>Looks up the required item in Coupa using the Coupa query.</td>
</tr>
<tr>
<td>Purchase Order Management</td>
<td>Cancel Purchase Order</td>
<td>Cancels the required purchase order in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Close Purchase Order</td>
<td>Closes the required purchase order in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Get PO Line</td>
<td>Retrieves details of the required purchase order line in Coupa.</td>
</tr>
<tr>
<td></td>
<td>Look Up Purchase Order</td>
<td>Looks up the required purchase order in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Look Up Purchase Orders</td>
<td>Looks up the required purchase orders in Coupa using the Coupa query.</td>
</tr>
<tr>
<td>Requisition Management</td>
<td>Create Draft Requisition</td>
<td>Creates a requisition in Coupa with its status as Draft.</td>
</tr>
<tr>
<td></td>
<td>Create Requisition</td>
<td>Creates a requisition in Coupa with its status as Pending Approval or Pending Buyer Action.</td>
</tr>
<tr>
<td></td>
<td>Get Requisition Fields</td>
<td>Retrieves the list of fields in the Coupa Requisitions table.</td>
</tr>
<tr>
<td></td>
<td>Note: This is a metadata action and doesn't make an API call to Coupa.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Look Up Requisition</td>
<td>Looks up the required requisition in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Look Up Requisitions</td>
<td>Looks up the required requisitions in Coupa using the Coupa query.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update Requisition</td>
<td>Update Requisition</td>
<td>Updates the details of the required requisition in Coupa.</td>
</tr>
<tr>
<td>Supplier Management</td>
<td>Look Up Supplier</td>
<td>Looks up the required supplier in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Look Up Supplier Items By Item ID</td>
<td>Looks up the required supplier in Coupa using the item ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Suppliers</td>
<td>Looks up for a list of suppliers in Coupa using the query.</td>
</tr>
<tr>
<td>User Management</td>
<td>Look Up User</td>
<td>Looks up the required user in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Look Up Users</td>
<td>Looks up the required users in Coupa using the Coupa query.</td>
</tr>
<tr>
<td></td>
<td>Reset User Password</td>
<td>Resets password of the required user in Coupa.</td>
</tr>
</tbody>
</table>

**Note:** Remote tables are created when the Coupa spoke is activated. Users are cautioned against directly modifying schema or inserting data in these tables.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Credentials and connection information](#).

**Set up Coupa spoke**

Integrate the ServiceNow instance and your Coupa account using an API key to authenticate ServiceNow requests.
- Request IntegrationHub subscription
- Activate the Coupa spoke
- Configure the system properties:
  - com.glide.transform.json.max-partial-length: Type as integer and Value as 16384000
  - glide.pf.rest.response_payload_max_size: Type as integer and Value as 100000000
- Role required: admin

*Create Credential records for the Coupa spoke*

Create Credential records to the Coupa application you created. The Coupa spoke connection and credential alias uses these credentials to authorize actions.

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   - The system displays the message **What type of Credentials would you like to create?**.
3. Select **API Key Credentials**.
   - A blank API Key Credentials form displays.
4. Enter these values.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Coupa Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>API Key</td>
<td>API key generated in your Coupa instance.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

Create **Connection records for the Coupa spoke**

Create a Connection record to the Coupa API. The Coupa spoke connection and credential alias uses these connections to perform actions in Coupa.

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open for the record for **Coupa**.
3. From the **Connections** tab, click **New**.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Coupa Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Coupa. For example, select Coupa Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Coupa organization URL. For example, https://&lt;instance-name&gt;.coupacloud.com.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Docker spoke**

Lookup Docker data from your ServiceNow instance. Automate changes in the Docker engine when an event occurs in ServiceNow.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.
Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

**Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported versions

Community Edition version 18.09.0.

Spoke actions

The Docker spoke provides actions to automate Docker tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Images Management</td>
<td>Create An Image</td>
<td>Creates an image in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>List Images</td>
<td>Lists images from the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Remove An Image</td>
<td>Removes an image from the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Search Images</td>
<td>Searches for images on Docker Hub.</td>
</tr>
<tr>
<td>Services Management</td>
<td>Create A Service</td>
<td>Creates a service in the Docker instance. Services are tasks run on a swarm.</td>
</tr>
<tr>
<td></td>
<td>Delete A Service</td>
<td>Deletes a service from the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Inspect A Service</td>
<td>Returns detailed information about a service in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Update A Service</td>
<td>Updates a service to the swarm on the docker instance.</td>
</tr>
<tr>
<td></td>
<td>List Services</td>
<td>Returns a list of services from the Docker instance.</td>
</tr>
<tr>
<td>Containers Management</td>
<td>Create A Container</td>
<td>Creates a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Inspect A Container</td>
<td>Inspects a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Kill A Container</td>
<td>Kills a container in the Docker instance.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>List Containers</td>
<td>Lists containers in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Pause A Container</td>
<td>Suspends all processes in a container on the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Remove A Container</td>
<td>Removes a container from the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Rename A Container</td>
<td>Renames a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Restart A Container</td>
<td>Restarts a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Start A Container</td>
<td>Starts a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Stop A Container</td>
<td>Stop a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Unpause A Container</td>
<td>Unpauses a container in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Update A Container</td>
<td>Updates a container in the Docker instance with the provided values.</td>
</tr>
<tr>
<td></td>
<td>Wait for A Container</td>
<td>Blocks all processes until a container stops, then returns the exit code for the container on the Docker instance.</td>
</tr>
<tr>
<td>Executions Management</td>
<td>Create An Exec Instance</td>
<td>Creates an exec instance in Docker, through which you can run a new command in a running container. To execute a command in a container, create and start an exec instance.</td>
</tr>
<tr>
<td></td>
<td>Inspect An Exec Instance</td>
<td>Inspects an exec instance in Docker.</td>
</tr>
<tr>
<td></td>
<td>Start An Exec Instance</td>
<td>Starts an exec instance in Docker, through which you can run a new command in a running container.</td>
</tr>
<tr>
<td>Networks Management</td>
<td>Create A Network</td>
<td>Creates a network on the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Inspect A Network</td>
<td>Returns detailed information about a network in the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>List Networks</td>
<td>Returns a list of networks from the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Remove A Network</td>
<td>Removes a network from the Docker instance.</td>
</tr>
<tr>
<td>Volumes Management</td>
<td>Create A Volume</td>
<td>Creates a volume in Docker.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Inspect A Volume</td>
<td>Returns detailed information about a volume in Docker.</td>
</tr>
<tr>
<td></td>
<td>List Volumes</td>
<td>Returns a list of volumes from Docker.</td>
</tr>
<tr>
<td></td>
<td>Remove A Volume</td>
<td>Removes a volume from the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Delete A Node</td>
<td>Deletes a node from the Docker instance.</td>
</tr>
<tr>
<td></td>
<td>Initialize A New Swarm</td>
<td>Initializes a new Docker swarm. A swarm is a group of machines running Docker joined into a cluster.</td>
</tr>
<tr>
<td></td>
<td>Inspect Swarm</td>
<td>Returns detailed information about a Docker swarm.</td>
</tr>
<tr>
<td></td>
<td>Join An Existing Swarm</td>
<td>Joins a node to a swarm as a manager or worker node based on the Docker token.</td>
</tr>
<tr>
<td></td>
<td>Leave A Swarm</td>
<td>Removes a Docker instance from a swarm.</td>
</tr>
<tr>
<td></td>
<td>Swarm Management</td>
<td></td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see [Credentials and connection information](#).

This spoke uses the Docker alias record to authorize actions. To use the spoke connection alias, create an associated Connection record. This spoke does not require a credential record.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Docker alias to configure where actions run as well as set MID Server selection attributes. For more information, see [MID server](#).

**Create Connection records for the Docker spoke**

Create Connection records to the Docker engine. The Docker spoke connection and credential alias uses these connections to perform actions on Docker.

- Request IntegrationHub subscription
- Activate Docker spoke
- Role required: admin

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open for the record for **Docker**.
3. From the **Connections** tab, click **New**.
The system displays a blank HTTP(s) Connection form.

4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Docker Connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>The IP address and port of the host machine where Docker is installed.</td>
</tr>
</tbody>
</table>

5. Click Submit.

**DocuSign spoke v1.1.6**

Automate the process of sending a document to an individual or list of recipients for digital signature using DocuSign. For example, automate employee onboarding and offboarding, or send non-disclosure agreements, legal agreements, and statements of work. Use ServiceNow data in document templates and enable users to upload documents for signature as needed.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Compatible versions**

This spoke was built for DocuSign API version v2, but may be compatible with later versions.

**Key features**

DocuSign spoke enables a flow designer to:

- Automate the process of sending a document from a ServiceNow attachment or DocuSign template to an individual or recipient list for digital signature.
- Discover and synchronize DocuSign accounts and templates in ServiceNow.
  - Retrieve a list of accounts and associated templates from DocuSign and then insert or update them as records in the Accounts [sn_docusign_spoke_accounts] and Templates [sn_docusign_spoke_docusign_templates] tables using the Get Accounts subflow.
  - Retrieve templates associated with a specified DocuSign account and then insert or update them as records in the Templates [sn_docusign_spoke_docusign_templates] table using the Get Templates Per Account subflow.
- Copy and customize sample flows for sending templates and on-demand document requests.
• Pause a flow until a document is signed. A scripted REST API webhook waits for the recipient to sign the document.
• Use values from a signed document in a flow.
• Attach a completed DocuSign document to a ServiceNow record for auditing purposes.
• Manage envelopes and users.

Spoke requirements

• DocuSign account
• DocuSign administrator credentials
• DocuSign application configured to integrate with ServiceNow
• DocuSign application details such as client ID, integrator key, secret keys, and RSA keypairs
• ServiceNow IntegrationHub subscription

Note: Ensure that you have activated the Flow Designer support for the Service Catalog (com.glideapp.servicecatalog.flow_designer) plugin.

See the DocuSign Developer Center documentation for instructions on creating and configuring custom applications.

Spoke flows

The DocuSign spoke provides sample flows to demonstrate automating DocuSign tasks. Use DocuSign spoke actions to automate any tasks desired by your organization. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send a Document for Digital Signature</td>
<td>Sends a document to DocuSign for a digital signature when a Service Catalog request is created by the Send a Document for Digital Signature item. Before using this flow, activate the Send a Document for Digital Signature catalog item.</td>
</tr>
<tr>
<td>Send employment offer to candidate using DocuSign template</td>
<td>Sends a DocuSign envelope to a user using a template. For example, use this flow to send a job offer to a candidate. Before using this flow, activate the Demonstrate Template - Send Job Offer to Candidate catalog item.</td>
</tr>
</tbody>
</table>

The DocuSign spoke adds catalog items for use with the DocuSign spoke sample flows. Before triggering a DocuSign spoke sample flow, activate these catalog items.

<table>
<thead>
<tr>
<th>Catalog item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send a Document for Digital Signature</td>
<td>Sends a document for digital signature in DocuSign.</td>
</tr>
<tr>
<td>Demonstrate Template - Send Job Offer to Candidate</td>
<td>Sends a job offer using a DocuSign template.</td>
</tr>
</tbody>
</table>
Spoke subflows

The DocuSign spoke provides a sample subflow to demonstrate automating DocuSign tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflow is, Get & Set DocuSign Field Data. The subflow processes a list of catalog item variables and updates a draft envelope with each variable value.

Spoke actions

The DocuSign spoke provides actions to automate DocuSign tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Get Accounts</td>
<td>Retrieves accounts associated with the spoke Connection and Credential alias record.</td>
</tr>
<tr>
<td>Document Signature</td>
<td>Get Embedded Signing URL</td>
<td>Creates a signing URL that is embedded into an application. User can sign the document without leaving the application.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Signing URL is active for 300 seconds and can be sent to one recipient at a time.</td>
</tr>
<tr>
<td>Document Management</td>
<td>Attach DocuSign Document to Record</td>
<td>Retrieves a signed DocuSign document and attaches it to a ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Get Document ID by Name</td>
<td>Retrieves the document ID from an envelope using the specified document name.</td>
</tr>
<tr>
<td>Envelope Management</td>
<td>Add Recipient to Envelope</td>
<td>Adds the specified recipient to the specified envelope.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Recipient ID used in this action is associated with the envelope and is different from the Recipient ID used in the Get All Template Fields action.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Administrator enters a numeric value for this Recipient ID.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Create Draft Envelope from Template</td>
<td>Creates a draft envelope from an existing DocuSign template.</td>
</tr>
<tr>
<td></td>
<td>Get Field ID</td>
<td>Retrieves the ID of the specified field from the specified draft envelope.</td>
</tr>
<tr>
<td></td>
<td>Get Field Value</td>
<td>Retrieves the value of the specified field from the specified envelope.</td>
</tr>
<tr>
<td></td>
<td>Get Recipient ID by Role Name</td>
<td>Retrieves the recipient ID of the specified role name from the specified envelope.</td>
</tr>
<tr>
<td></td>
<td>Send Adhoc Signature Request to User</td>
<td>Sends a DocuSign document associated with the specified ServiceNow record to the specified recipient for signature.</td>
</tr>
<tr>
<td></td>
<td>Send Adhoc Signature Request to Users</td>
<td>Sends a DocuSign document associated with the specified ServiceNow record to the specified multiple recipients for signatures at a time.</td>
</tr>
<tr>
<td></td>
<td>Send Envelope</td>
<td>Sends an envelope to the specified recipients.</td>
</tr>
<tr>
<td></td>
<td>Set Field Value</td>
<td>Sets the value of the specified field in the specified draft envelope.</td>
</tr>
<tr>
<td></td>
<td>Wait for Signature from DocuSign</td>
<td>Pauses a flow until the specified document has been signed or rejected. Returns the status of the document to the flow for further processing.</td>
</tr>
<tr>
<td>Template Management</td>
<td>Get Templates Per Account</td>
<td>Retrieves the templates associated with the specified DocuSign account.</td>
</tr>
</tbody>
</table>
### Category | Action | Description
--- | --- | ---
Get Template Fields | Retrieves all fields in a template that is defined for a recipient.  
**Note:**
- Recipient ID used in this action is associated with the template and is different from the Recipient ID used in the Add Recipient to Envelope action.  
- Value of the Recipient ID is a unique system-generated number.
Get Template Recipients | Retrieves all recipients defined for a template.
User Management | Create User | Creates a DocuSign user with the specified user details.
 | Delete User | Deletes the specified DocuSign user.

## Spoke module

The DocuSign spoke adds a DocuSign module to your ServiceNow instance. The DocuSign spoke synchronizes and stores templates and envelopes in ServiceNow. The DocuSign spoke includes these tables and records.

<table>
<thead>
<tr>
<th>Table/Record</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Aliases</td>
<td>The DocuSign connection alias.</td>
</tr>
<tr>
<td>Scheduled Job</td>
<td>The Get Accounts &amp; Templates scheduled job that synchronizes templates and envelopes with your DocuSign account.</td>
</tr>
<tr>
<td>Accounts</td>
<td>DocuSign accounts synchronized with your ServiceNow instance. To synchronize accounts, see <a href="#">Synchronize DocuSign with ServiceNow</a>. The Get Accounts subflow retrieves a list of accounts and associated templates from DocuSign and then inserts or updates them as records in the Accounts [sn_docusign_spoke_accounts] and Templates [sn_docusign_spoke_docusign_templates] tables.</td>
</tr>
<tr>
<td>Templates</td>
<td>DocuSign templates from synchronized DocuSign accounts. The Get Templates Per Account subflow retrieves templates associated with a specified DocuSign account and then inserts or updates them as records in the Templates [sn_docusign_spoke_docusign_templates] table.</td>
</tr>
<tr>
<td>Table/Record</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Envelopes</td>
<td>DocuSign envelopes from synchronized DocuSign accounts. Records in the</td>
</tr>
<tr>
<td></td>
<td>Envelopes table are updated only when webhook is configured for the DocuSign</td>
</tr>
<tr>
<td></td>
<td>account.</td>
</tr>
</tbody>
</table>

The DocuSign spoke tables include these fields.

<table>
<thead>
<tr>
<th>Table</th>
<th>Fields</th>
</tr>
</thead>
</table>
| Accounts [sn_docsign_spoke_accounts] | • Account ID  
• Account Name  
• Description  
• Email  
• Alias  
• Display Name |
| Templates [sn_docsign_spoke_docusign_templates] | • Account  
• Template ID  
• Name  
• Description  
• Last Modified  
• Display Name |
| Envelopes [sn_docsign_spoke_envelopes] | • Account  
• ID  
• Status  
• Signed Date  
• Declined Reason  
• Display name  
• Embedded Signing  
• Signed Date Time Zone  
• Template |

**DocuSign account requirements**

The DocuSign spoke requires configuring your DocuSign account to generate an OAuth 2.0 JWT Bearer Grant token.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Credentials and connection information.

This spoke uses the DocuSign Connection & Credential Alias record to authorize actions.
MID Server requirements

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the DocuSign alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

Set up DocuSign spoke

Integrate your DocuSign account with your ServiceNow instance. Create a custom OAuth application in DocuSign and authenticate requests from ServiceNow.

Role required: admin

- Request IntegrationHub subscription
- Activate DocuSign spoke

Configure DocuSign account

Create a custom OAuth application from your DocuSign account to enable OAuth 2.0 authentication with the DocuSign spoke. Configure the webhook in your DocuSign account to enable DocuSign to send data to ServiceNow when a recipient signs a document.

DocuSign requirements:

- DocuSign account
- DocuSign administrator credentials
- DocuSign app configured to integrate with ServiceNow

Complete these steps from your DocuSign account. See the DocuSign Developer Center documentation for instructions on creating and configuring custom applications. DocuSign uses a scripted webhook to send signed document data to ServiceNow. This enables flow designers to pause a flow until a document is signed, and use document data in the flow.

1. From your DocuSign account, register your application.

   Note: Ensure that you select the Authorization Code Grant option for User Application.

2. Generate an integrator key.
3. Generate a secret key.
4. Record the integrator key and secret key to register the app as a third-party OAuth provider on your ServiceNow instance.
5. Click ADD RSA KEYPAIR and record the Keypair ID, Public Key, and Private Key.
6. In Redirect URIs, add your ServiceNow instance URL in this format: https://{instance-name}.service-now.com/api/sn_docusign_spoke/docusign_webhook.

Generate the JKS certificate

Generate a JKS certificate for the JWT authentication of the DocuSign spoke.

Role required: admin

1. Open the text editor for code such as, Sublime Text.
2. Create a new file.
3. Paste the Private Key you had earlier generated from your DocuSign integrator app. For more information, see Configure DocuSign account.

   Note: Ensure that you include both beginning and ending of the private key.

4. Save the file with the .key extension. For example, privatekey.key.
5. Open terminal and navigate to the directory where you saved the file with the .key extension.
6. Create a CA signed certificate using your private key by executing the command:

   ```bash
   openssl req -new -x509 -key <file-name>.key -out <certificate-name>.pem -days 1095
   ```

   System prompts you to provide required details such as Country Name, Province Name and so on.
7. Enter the required details.
8. Create PKCS 12 file using your private key and CA signed certificate by executing the command:

   ```bash
   openssl pkcs12 -export -in <certificate-name>.pem -inkey <file-name>.key -certfile <certificate-name>.pem -out <PKCS-12-file-name>.p12
   ```

   System prompts you to provide a password.
9. Provide the export password.
10. Create the JKS file by executing this command:

    ```bash
    keytool -importkeystore -srckeystore <PKCS-12-file-name>.p12 -srcstoretype pkcs12 -destkeystore <JKS-certificate-filename>.jks -deststoretype JKS
    ```

    System prompts you to provide a password.
11. Provide the destination and source keystore passwords.

    **Attach a Java Key Store certificate to the DocuSign spoke**
    Enable the JWT Bearer Grant token authentication by attaching a valid Java KeyStore (JKS) certificate to the DocuSign spoke.
    - Ensure the availability of a valid Java KeyStore certificate
    - Role required: admin

    1. Navigate to **System Definition > Certificates**.
    2. Click **New**.
    3. Complete the form.

    **X.509 Certificate form fields**

    | Field                  | Description                                                                 |
    |------------------------|-----------------------------------------------------------------------------|
    | Name                   | Enter a name to uniquely identify the record. For example, DocuSign Certificate. |
    | Notify on expiration   | Define users to be notified when the certificate expires.                   |
    | Warn in days to expire | Enter the number of days to send a notification before the certificate expires. |
    | Active                 | Enable                                                                      |
    | Type                   | Select Java Key Store.                                                      |
    | Expires in days        | Enter the number of days until the certificate expires.                     |
    | Key store password     | Enter a password associated with the certificate.                           |
    | Short description      | Enter a summary about the certificate.                                      |
4. Click the attachments icon (_attach) and attach a JKS certificate.

5. Click Validate Stores/Certificates.

Create a JWT signing key for the DocuSign spoke
Create a JSON Web Token (JWT) signing key to assign to your Java KeyStore certificate.

1. Navigate to System OAuth > JWT Keys.
2. Click New.
3. Complete the form.

**JWT Keys form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name to uniquely identify the JWT signing key. For example, DocuSign JWT Keys.</td>
</tr>
<tr>
<td>Signing Keystore</td>
<td>Select the valid JKS certificate attached in the previous task. For example, DocuSign Certificate.</td>
</tr>
<tr>
<td>Key Id</td>
<td>Enter a key Id to identify which key is used when multiple keys are used to sign tokens.</td>
</tr>
<tr>
<td>Signing Algorithm</td>
<td>Select an algorithm to sign with the JWT key.</td>
</tr>
<tr>
<td>Signing Key Password</td>
<td>Enter a password associated with the signing key.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Create a JWT provider for the DocuSign spoke
Add a JSON Web Token (JWT) provider to your ServiceNow instance.

1. Navigate to System OAuth > JWT Providers.
2. Click New.
3. On the JWT Provider form, fill the values.

**JWT Provider form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name to uniquely identify the JWT provider. For example, DocuSign JWT Provider.</td>
</tr>
<tr>
<td>Expiry Interval (sec)</td>
<td>Enter a number in seconds to set the lifespan of JWT provider tokens.</td>
</tr>
<tr>
<td>Signing Configuration</td>
<td>Select a JWT signing key. For example, DocuSign JWT Keys.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click Save.
The Standard Claims and Custom Claims related lists display.

5. Select the JWT provider created for the DocuSign spoke.

6. Enter values for iss, sub, and aud in the Standard Claims related list. See the DocuSign Developer Center for instructions.
7. Insert a record in the **Custom Claims** related list and complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Claim Name</td>
<td>scope</td>
</tr>
<tr>
<td>Claim Value Type</td>
<td>string</td>
</tr>
<tr>
<td>Claim Value</td>
<td>signature impersonation</td>
</tr>
</tbody>
</table>

8. Click **Update**.

**Register DocuSign as OAuth Provider**

Use the information generated during DocuSign account configuration to register DocuSign as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

1. Navigate to **System OAuth > Application Registry**.
2. Click **New**.
   
   The system displays the message **What kind of OAuth application?**
3. Select **Connect to a third party OAuth Provider**.
   The system displays a blank Application Registries form.
4. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter DocuSign OAuth.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the integrator key you generated during the DocuSign account configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the client secret you generated during the DocuSign account configuration.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select <strong>JWT Bearer</strong>.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>• For developer sandbox environment, enter <a href="https://account-d.docusign.com/oauth/auth">https://account-d.docusign.com/oauth/auth</a>.</td>
</tr>
<tr>
<td></td>
<td>• For live production system, enter <a href="https://account.docusign.com/oauth/auth">https://account.docusign.com/oauth/auth</a>.</td>
</tr>
<tr>
<td>Token URL</td>
<td>• For developer sandbox environment, enter <a href="https://account-d.docusign.com/oauth/token">https://account-d.docusign.com/oauth/token</a>.</td>
</tr>
<tr>
<td></td>
<td>• For live production system, enter <a href="https://account.docusign.com/oauth/token">https://account.docusign.com/oauth/token</a>. For more information see, see Post Go-Live and User Info Endpoint Reference in the DocuSign Developer Center documentation.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click **Save**.

   - The system validates the OAuth credentials and populates the **Redirect URL**.
   - The system populates **OAuth Entity Profile** with **Grant Type** as **JWT Bearer**. For example, **OAuth Entity Profile** is created with default Name, DocuSign OAuth default_profile
6. Insert a record in the **OAuth Entity Scopes** related list and fill the values.

**OAuth Entity Scopes related list fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><strong>scope</strong></td>
</tr>
<tr>
<td>OAuth Scope</td>
<td>signature impersonation</td>
</tr>
</tbody>
</table>

7. Copy the value from **Redirect URL**.
8. Click **Update**.
9. Login to your DocuSign account to edit the configuration of your custom DocuSign application. See the [DocuSign Developer Center](https://developer.docusign.com/) for instructions.

The instance can request OAuth 2.0 tokens for the spoke.

**Note:** When an OAuth token expires, the spoke automatically regenerates a new token in most cases. If a token expires and is not regenerated, an administrator can regenerate the spoke OAuth token.

**Obtain consent**
Obtain explicit consent for the ServiceNow application from DocuSign.

Role required: admin

**Obtain consent for individuals**

1. Navigate to **System OAuth > Application Registry**.
2. Open the record you had created for the DocuSign spoke.
3. Insert a record in the **OAuth Entity Profiles** related list and fill the values.

**OAuth Entity Profiles related list fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>DocuSign OAuth default_profile_Auth_Code</td>
</tr>
<tr>
<td>Is default</td>
<td>true</td>
</tr>
<tr>
<td>Grant type</td>
<td>Authorization Code</td>
</tr>
</tbody>
</table>

4. Click the created OAuth Entity Profile.
5. Insert a record in the **OAuth Entity Scopes** related list and fill the values.

**OAuth Entity Scopes related list fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><strong>scope</strong></td>
</tr>
<tr>
<td>OAuth Scope</td>
<td>signature impersonation</td>
</tr>
</tbody>
</table>
6. Create credential record associated with the OAuth Entity profile whose Grant type is Authorization Code.
   a. Navigate to Connections & Credentials > Credentials.
   b. Click New. The system displays the message What type of Credentials would you like to create?
   c. Select OAuth 2.0 Credentials.
   d. Fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter DocuSign Credentials Auth Code.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth Entity profile you created with Grant type as Authorization Code. For example, select DocuSign OAuth default_profile/Auth_Code.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

   e. Save the record.
   f. Click the Get OAuth Token related link to generate the OAuth token.
   g. Enter your DocuSign user name and password to provide the consent.

7. Create another credential record associated with the OAuth Entity profile whose Grant type is JWT Bearer. See Create Credential records for the DocuSign spoke for the required information. After the credential record, click the Get OAuth Token related link to generate the OAuth token.

Obtain consent for an organization administrator

See DocuSign Developer documentation (Admin consent for internal applications) for instructions to obtain consent for an organization administrator.

Create Credential records for the DocuSign spoke
Create Credential records to the DocuSign custom OAuth application you created during DocuSign account configuration. The DocuSign spoke connection and credential alias uses these credentials to authorize actions.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?
3. Select OAuth 2.0 Credentials.
   The pop-up window displays a blank OAuth 2.0 Credentials form.
4. Fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter DocuSign Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom DocuSign application as an OAuth provider. For example, select DocuSign OAuth default_profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Save the record.
6. Click the Get OAuth Token related link to generate the OAuth token.

Create Connection records for the DocuSign spoke

Create Connection records to your DocuSign account. The DocuSign spoke connection and credential alias uses these connections to perform actions in DocuSign.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for DocuSign.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter DocuSign Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for DocuSign. For example, select DocuSign Credentials.</td>
</tr>
</tbody>
</table>
| Connection URL   | • For demo environment, enter https://demo.docusign.net.  
                    • For live production system, enter the Base URI such as na2.docusign.net or eu.docusign.net. For instructions on obtaining the base URI, see Post Go-Live and User Info Endpoint Reference in the DocuSign Developer Center documentation. |

5. Click Submit.

Synchronize ServiceNow with DocuSign to access DocuSign accounts, templates, and envelopes from the DocuSign spoke. See Synchronize DocuSign with ServiceNow.

Configure DocuSign webhook

Configure the webhook in your DocuSign account to enable DocuSign to send data to ServiceNow when a recipient signs a document.
Role required: admin

1. Connect a custom configuration to enable your DocuSign application to share events and data with your ServiceNow instance.

2. Add your ServiceNow instance URL in this format: `https://{instance-name}.service-now.com/api/sn_docusign_spoke/docusign_webhook`.

3. Include basic authorization in the header and add your ServiceNow credentials.

4. Enable DocuSign to share envelope events with ServiceNow.
   - Envelope Sent
   - Envelope Delivered
   - Envelope Signed/Completed
   - Envelope Declined
   - Envelope Voided

Synchronize DocuSign with ServiceNow

Synchronize ServiceNow with DocuSign to access DocuSign accounts, templates, and envelopes from the DocuSign spoke.

Role required: admin

- Request IntegrationHub subscription
- Activate DocuSign spoke
- Set up DocuSign spoke

Schedule a job to synchronize DocuSign with your ServiceNow instance daily, or synchronize data as needed.

1. Required: Schedule a job to synchronize DocuSign data with your ServiceNow instance.
   a) Navigate to DocuSign > Scheduled Job.
      - The Get Accounts & Templates scheduled job opens.
   b) Select Active.

   The DocuSign spoke synchronizes accounts, templates, and envelopes daily.

2. Required: Synchronize DocuSign data as needed with a UI action.
   a) Navigate to DocuSign > Accounts.
      - The Accounts [sn_docusign_spoke_accounts] table opens.
   b) Click the Get Accounts related link.

   The system synchronizes all accounts linked through an OAuth Credential record and populates the Templates and Envelopes tables with DocuSign data. Use template and envelope records when constructing flows.

Activate DocuSign spoke catalog items

Trigger events in DocuSign when an item is requested in the Service Catalog. For example, The Send a Document for Digital Signature catalog item triggers a sample flow that sends a DocuSign document to a designated recipient.

Role required: admin

- Request IntegrationHub subscription
- Activate DocuSign spoke
• Activate the Flow Designer support for the Service Catalog (com.glideapp.servicecatalog.flow_designer) plugin

The DocuSign spoke adds catalog items for use with the DocuSign spoke sample flows. Before triggering a DocuSign spoke sample flow, activate these catalog items.

<table>
<thead>
<tr>
<th>Catalog item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send a Document for Digital Signature</td>
<td>Sends a document for digital signature in DocuSign.</td>
</tr>
<tr>
<td>Demonstrate Template - Send Job Offer to Candidate</td>
<td>Sends a job offer using a DocuSign template.</td>
</tr>
</tbody>
</table>

1. Navigate to **Service Catalog > Maintain Items**.
2. Search for and select **Send a Document for Digital Signature**.
3. Click **Activate**.
4. Open the record, **Send a Document for Digital Signature**.
5. In the **Process Engine** tab, select **Send a Document for Digital Signature** for Flow.
6. Search for and select **Demonstrate Template - Send Job Offer to Candidate**.
7. Click **Activate**.
8. Open the record, **Demonstrate Template - Send Job Offer to Candidate**.
9. In the **Process Engine** tab, select **Send employment offer to candidate using DocuSign template** for Flow.

When one of these items is requested in the Service Catalog, the associated DocuSign spoke sample flow triggers and performs actions in DocuSign.

**How to automate on-demand signing requests**

Send DocuSign on-demand signing requests using information in your ServiceNow instance by creating flows in Flow Designer.

Role required: admin

• Request IntegrationHub subscription
• Activate DocuSign spoke
• Set up DocuSign spoke

**Note:** Customize flows in Flow Designer based on your requirements.

1. In Flow Designer, create a flow.
2. Specify **TRIGGER** to initiate the flow.
3. Specify the **ACTIONS** to be performed during the flow. The actions include one of the following:
   • **Send Adhoc Signature Request To User**
   • **Send Adhoc Signature Request To Users**
4. Optional: To pause the flow until the specified document is signed or rejected, select the **Wait for Signature from DocuSign** action.
5. Perform one of the following set of actions:
   • To send an embedded signing URL, select **Use Embedded Signing**, and **Embedded Signing Recipient [User]**.
   • To send a document for signing, provide details regarding DocuSign account, PDF document, recipient, email, and envelope expiry.
   • The selected document or Embedded Signing URL is sent to the recipients for signing. While signing the document, the recipient details are auto-populated.
   • An envelope record is created in the **Envelopes** table. The Envelope status and other details are updated.

### How to automate signing requests using templates

Send DocuSign signing requests using DocuSign templates and information in your ServiceNow instance by creating flows in Flow Designer. For example, **Send employee offer**.

Role required: admin

- Request IntegrationHub subscription
- Activate DocuSign spoke
- Set up DocuSign spoke

**Note:** Customize flows based on your requirements.

1. In DocuSign, create document templates and specify recipient roles. For example, **Candidate** and **Manager**. The system retrieves other recipient details such as name and email, when the flow is triggered.
2. In Flow Designer, create a new flow.
3. Specify **TRIGGER** to initiate the flow.
4. Specify the **ACTIONS** to be performed during the flow and provide recipient details. The actions include:
   • **Create Draft Envelope from Template**
   • **Get Recipient ID by Role Name**
   • **Add Recipient to Envelope**
   • **Get Recipient ID by Role Name**
   • **Add Recipient to Envelope**
   • **Get Field ID**
   • **Set Field Value**
   • **Send Envelope**
   • **Get Field Value**
5. Optional: To pause the flow until the specified document is signed or rejected, select the **Wait for Signature from DocuSign** action.
   • The selected document or Embedded Signing URL is sent to the recipients for signing. While signing the document, the recipient details are auto-populated.
   • An envelope record is created in the **Envelopes** table. The Envelope status and other details are updated.
**DocuSign spoke v1.2.2**

Automate the process of sending a document to an individual or list of recipients for digital signature using DocuSign. For example, automate employee onboarding and offboarding, or send non-disclosure agreements, legal agreements, and statements of work. Use ServiceNow data in document templates and enable users to upload documents for signature as needed.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)

**Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

**Compatible versions**

This spoke was built for DocuSign API version v2 or v2.1, but may be compatible with later versions.

**Key features**

DocuSign spoke enables a flow designer to:

- Automate the process of sending a document from a ServiceNow attachment or DocuSign template to an individual or recipient list for digital signature.
- Restrict access to DocuSign data based on a user's role. For example, your company may have one DocuSign account used by the HR team and another used by the Legal team. To keep the data separate between these two accounts, you can create a role for each account and add it to the accounts record.
• Discover and synchronize DocuSign accounts and templates in ServiceNow.
  • Retrieve a list of accounts and associated templates from DocuSign and then insert or update them as records in the Accounts [sn_docusign_spoke_accounts] and Templates [sn_docusign_spoke_docusign_templates] tables.
  • Retrieve templates associated with a specified DocuSign account and then insert or update them as records in the Templates [sn_docusign_spoke_docusign_templates] table.
• Copy and customize sample flows for sending templates and on-demand document requests.
• Pause a flow until a document is signed. A scripted REST API webhook waits for the recipient to sign the document.
• Use values from a signed document in a flow.
• Attach a completed DocuSign document to a ServiceNow record for auditing purposes.
• Manage envelopes and users.

Spoke requirements

• DocuSign account
• DocuSign administrator credentials
• DocuSign application configured to integrate with ServiceNow
• DocuSign application details such as client ID, integrator key, secret keys, and RSA keypairs
• ServiceNow IntegrationHub subscription

Note: Ensure that you have activated the Flow Designer support for the Service Catalog (com.glideapp.servicecatalog.flow_designer) plugin.

See the DocuSign Developer Center documentation for instructions on creating and configuring custom applications.

Spoke flows

The DocuSign spoke provides sample flows to demonstrate automating DocuSign tasks. Use DocuSign spoke actions to automate any tasks desired by your organization. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send a Document for Digital Signature</td>
<td>Sends a document to DocuSign for a digital signature when a Service Catalog request is created by the <strong>Send a Document for Digital Signature</strong> item. Before using this flow, activate the <strong>Send a Document for Digital Signature</strong> catalog item.</td>
</tr>
<tr>
<td>Send employment offer to candidate using DocuSign template</td>
<td>Sends a DocuSign envelope to a user using a template. For example, use this flow to send a job offer to a candidate. Before using this flow, activate the <strong>Demonstrate Template - Send Job Offer to Candidate</strong> catalog item.</td>
</tr>
</tbody>
</table>

The DocuSign spoke adds catalog items for use with the DocuSign spoke sample flows. Before triggering a DocuSign spoke sample flow, activate these catalog items.
<table>
<thead>
<tr>
<th>Catalog item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send a Document for Digital Signature</td>
<td>Sends a document for digital signature in DocuSign.</td>
</tr>
<tr>
<td>Demonstrate Template - Send Job Offer to Candidate</td>
<td>Sends a job offer using a DocuSign template.</td>
</tr>
</tbody>
</table>

**Spoke subflows**

The DocuSign spoke provides sample subflows to demonstrate automating DocuSign tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach DocuSign Envelope To ServiceNow Record</td>
<td>Attaches all the documents in an envelope to a ServiceNow record.</td>
</tr>
<tr>
<td>Get &amp; Set DocuSign Field Data</td>
<td>Processes a list of catalog item variables and updates a draft envelope with each variable value.</td>
</tr>
</tbody>
</table>

**Spoke actions**

The DocuSign spoke provides actions to automate DocuSign tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Get Accounts</td>
<td>Retrieves accounts associated with the spoke Connection and Credential alias record.</td>
</tr>
<tr>
<td>Document Signature</td>
<td>Get Embedded Signing URL</td>
<td>Creates a signing URL that is embedded into an application. User can sign the document without leaving the application.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Signing URL is active for 300 seconds and can be sent to one recipient at a time.</td>
<td></td>
</tr>
<tr>
<td>Document Management</td>
<td>Attach DocuSign Document to Record</td>
<td>Retrieves a signed DocuSign document and attaches it to a ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Get Document ID by Name</td>
<td>Retrieves the document ID from an envelope using the specified document name.</td>
</tr>
<tr>
<td></td>
<td>Get Documents In An Envelope</td>
<td>Returns a list of documents with an ID and name in the given DocuSign envelope.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Envelope Management</td>
<td>Add Recipient to Envelope</td>
<td>Adds the specified recipient to the specified envelope.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Recipient ID used in this action is associated with the envelope and is different from the Recipient ID used in the Get All Template Fields action.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Administrator enters a numeric value for this Recipient ID.</td>
</tr>
<tr>
<td></td>
<td>Create Draft Envelope from Template</td>
<td>Creates a draft envelope from an existing DocuSign template.</td>
</tr>
<tr>
<td></td>
<td>Get Field ID</td>
<td>Retrieves the ID of the specified field from the specified draft envelope.</td>
</tr>
<tr>
<td></td>
<td>Get Field Value</td>
<td>Retrieves the value of the specified field from the specified envelope.</td>
</tr>
<tr>
<td></td>
<td>Get Recipient ID by Role Name</td>
<td>Retrieves the recipient ID of the specified role name from the specified envelope.</td>
</tr>
<tr>
<td></td>
<td>Get Recipients In An Envelope</td>
<td>Returns a list of recipients with a Recipient ID and Role Name from the given DocuSign envelope.</td>
</tr>
<tr>
<td></td>
<td>Send Adhoc Signature Request to User</td>
<td>Sends a DocuSign document associated with the specified ServiceNow record to the specified recipient for signature.</td>
</tr>
<tr>
<td></td>
<td>Send Adhoc Signature Request to Users</td>
<td>Sends a DocuSign document associated with the specified ServiceNow record to the specified multiple recipients for signatures at a time.</td>
</tr>
<tr>
<td></td>
<td>Send Envelope</td>
<td>Sends an envelope to the specified recipients.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> All recipient details must be provided before sending an envelope.</td>
</tr>
<tr>
<td></td>
<td>Set Field Value</td>
<td>Sets the value of the specified field in the specified draft envelope.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ServiceNow    DocVersion    Now Platform  capabilities</td>
<td>Wait for Signature from DocuSign</td>
<td>Pauses a flow until the specified document has been signed or rejected. Returns the status of the document to the flow for further processing.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get List Of Documents</td>
<td>Gets the list of all DocuSign documents in an envelope.</td>
</tr>
<tr>
<td>Template Management</td>
<td>Get Templates Per Account</td>
<td>Retrieves the templates associated with the specified DocuSign account.</td>
</tr>
<tr>
<td></td>
<td>Get Template Fields</td>
<td>Retrieves all fields in a template that is defined for a recipient.</td>
</tr>
<tr>
<td></td>
<td>Get Template Recipients</td>
<td>Retrieves all recipients defined for a template.</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates a DocuSign user with the specified user details.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes the specified DocuSign user.</td>
</tr>
</tbody>
</table>

**Spoke module**

The DocuSign spoke adds a DocuSign module to your ServiceNow instance. The DocuSign spoke synchronizes and stores templates and envelopes in ServiceNow. The DocuSign spoke includes these tables and records.

<table>
<thead>
<tr>
<th>Table/Record</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Aliases</td>
<td>The DocuSign connection alias.</td>
</tr>
<tr>
<td>Scheduled Job</td>
<td>The Get Accounts &amp; Templates scheduled job that synchronizes templates and envelopes with your DocuSign account.</td>
</tr>
<tr>
<td>Table/Record</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Accounts</td>
<td>DocuSign accounts synchronized with your ServiceNow instance. To synchronize accounts, see <a href="#">Synchronize DocuSign with ServiceNow</a>. The Get Accounts subflow retrieves a list of accounts and associated templates from DocuSign and then inserts or updates them as records in the Accounts [sn_docusign_spoke_accounts] and Templates [sn_docusign_spoke_docusign_templates] tables.</td>
</tr>
<tr>
<td>Templates</td>
<td>DocuSign templates from synchronized DocuSign accounts. The Get Templates Per Account subflow retrieves templates associated with a specified DocuSign account and then inserts or updates them as records in the Templates [sn_docusign_spoke_docusign_templates] table.</td>
</tr>
<tr>
<td>Envelopes</td>
<td>DocuSign envelopes from synchronized DocuSign accounts, including a Recipients related list that includes information about who the envelopes were sent to and the envelope status. Records in the Envelopes table are updated only when webhook is configured for the DocuSign account.</td>
</tr>
</tbody>
</table>

The DocuSign spoke tables include these fields.

<table>
<thead>
<tr>
<th>Table</th>
<th>Fields</th>
</tr>
</thead>
</table>
| Accounts [sn_docusign_spoke_accounts] | • Account ID  
                                       • Account Name   
                                       • Description    
                                       • Email          
                                       • Alias          
                                       • Display Name   |
| Templates [sn_docusign_spoke_docusign_templates] | • Account  
                                                  • Template ID  
                                                  • Name         
                                                  • Description  
                                                  • Last Modified  
                                                  • Display Name  |
| Envelopes [sn_docusign_spoke_envelopes] | • Account  
                                                  • ID           
                                                  • Status       
                                                  • Signed Date  
                                                  • Declined Reason  
                                                  • Display name  
                                                  • Embedded Signing  
                                                  • Signed Date Time Zone  
                                                  • Template  |
DocuSign account requirements

The DocuSign spoke requires configuring your DocuSign account to generate an OAuth 2.0 JWT Bearer Grant token.

Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Credentials and connection information.

This spoke uses the DocuSign Connection & Credential Alias record to authorize actions.

MID Server requirements

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the DocuSign alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

Create connection aliases for additional DocuSign accounts

If your DocuSign implementation includes multiple DocuSign accounts, create a connection alias for each account.

Role required: admin

Your company may have a DocuSign account for each department that uses DocuSign. To use multiple accounts with this spoke, create an alias for each account. At runtime, the system identifies the alias associated with the account and sends the correct connection and credential information in the request.

If your company only has one account, you can use the default DocuSign alias provided with the spoke and proceed to Set up DocuSign spoke.

1. Navigate to DocuSign > Connection Aliases.
2. Select New.
3. In the Name field, add a descriptive name for the account. For example, DocuSign HR account.
4. Save the record.

Set up DocuSign spoke for each connection alias in your DocuSign implementation.

Set up DocuSign spoke

Integrate your DocuSign account with your ServiceNow instance. Create a custom OAuth application in DocuSign and authenticate requests from ServiceNow.

Role required: admin

• Request IntegrationHub subscription
• Activate DocuSign spoke

Perform these set up tasks for each connection alias in your DocuSign implementation.

Configure DocuSign account

Create a custom OAuth application from your DocuSign account to enable OAuth 2.0 authentication with the DocuSign spoke. Configure the webhook in your DocuSign account to enable DocuSign to send data to ServiceNow when a recipient signs a document.

DocuSign requirements:
ServiceNow DocVersion Now Platform capabilities

- DocuSign account
- DocuSign administrator credentials
- DocuSign app configured to integrate with ServiceNow

Complete these steps from your DocuSign account. See the DocuSign Developer Center documentation for instructions on creating and configuring custom applications. DocuSign uses a scripted webhook to send signed document data to ServiceNow. This enables flow designers to pause a flow until a document is signed, and use document data in the flow.

1. From your DocuSign account, register your application.

   ![Note: Ensure that you select the Authorization Code Grant option for User Application.]

2. Generate an integrator key.
3. Generate a secret key.
4. Record the integrator key and secret key to register the app as a third-party OAuth provider on your ServiceNow instance.
5. Click ADD RSA KEYPAIR and record the Keypair ID, Public Key, and Private Key.
6. In Redirect URIs, add your ServiceNow instance URL in this format: https://{instance-name}.service-now.com/api/sn_docusign_spoke/docusign_webhook.

**Generate the JKS certificate**
Generate a JKS certificate for the JWT authentication of the DocuSign spoke.

Role required: admin

1. Open the text editor for code such as, Sublime Text.
2. Create a new file.
3. Paste the Private Key you had earlier generated from your DocuSign integrator app. For more information, see Configure DocuSign account.

   ![Note: Ensure that you include both beginning and ending of the private key.]

4. Save the file with the .key extension. For example, privatekey.key.
5. Open terminal and navigate to the directory where you saved the file with the .key extension.
6. Create a CA signed certificate using your private key by executing the command:

    openssl req -new -x509 -key <file-name>.key -out <certificate-name>.pem -days 1095

    System prompts you to provide required details such as Country Name, Province Name and so on.
7. Enter the required details.
8. Create PKCS 12 file using your private key and CA signed certificate by executing the command:

    openssl pkcs12 -export -in <certificate-name>.pem -inkey <file-name>.key -certfile <certificate-name>.pem -out <PKCS-12-file-name>.p12

    System prompts you to provide a password.
9. Provide the export password.
10. Create the JKS file by executing this command:

    keytool -importkeystore -srckeystore <PKCS-12-file-name>.p12 -srcstoretype pkcs12 -destkeystore <JKS-certificate-filename>.jks -deststoretype JKS

    System prompts you to provide a password.
11. Provide the destination and source keystore passwords.

**Attach a Java Key Store certificate to the DocuSign spoke**
Enable the JWT Bearer Grant token authentication by attaching a valid Java KeyStore (JKS) certificate to the DocuSign spoke.

- Ensure the availability of a valid Java KeyStore certificate
- Role required: admin

1. Navigate to **System Definition > Certificates**.
2. Click **New**.
3. Complete the form.

**X.509 Certificate form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name to uniquely identify the record. For example, DocuSign Certificate.</td>
</tr>
<tr>
<td>Notify on expiration</td>
<td>Define users to be notified when the certificate expires.</td>
</tr>
<tr>
<td>Warn in days to expire</td>
<td>Enter the number of days to send a notification before the certificate expires.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Type</td>
<td>Select Java Key Store.</td>
</tr>
<tr>
<td>Expires in days</td>
<td>Enter the number of days until the certificate expires.</td>
</tr>
<tr>
<td>Key store password</td>
<td>Enter a password associated with the certificate.</td>
</tr>
<tr>
<td>Short description</td>
<td>Enter a summary about the certificate.</td>
</tr>
</tbody>
</table>

4. Click the attachments icon (🔍) and attach a JKS certificate.
5. Click **Validate Stores/Certificates**.

**Create a JWT signing key for the DocuSign spoke**
Create a JSON Web Token (JWT) signing key to assign to your Java KeyStore certificate.

1. Navigate to **System OAuth > JWT Keys**.
2. Click **New**.
3. Complete the form.

**JWT Keys form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name to uniquely identify the JWT signing key. For example, DocuSign JWT Keys.</td>
</tr>
<tr>
<td>Signing Keystore</td>
<td>Select the valid JKS certificate attached in the previous task. For example, DocuSign Certificate.</td>
</tr>
<tr>
<td>Key Id</td>
<td>Enter a key Id to identify which key is used when multiple keys are used to sign tokens.</td>
</tr>
</tbody>
</table>
Create a JWT provider for the DocuSign spoke
Add a JSON Web Token (JWT) provider to your ServiceNow instance.

1. Navigate to System OAuth > JWT Providers.
2. Click New.
3. On the JWT Provider form, fill the values.

JWT Provider form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name to uniquely identify the JWT provider. For example, DocuSign JTW Provider.</td>
</tr>
<tr>
<td>Expiry Interval (sec)</td>
<td>Enter a number in seconds to set the lifespan of JWT provider tokens.</td>
</tr>
<tr>
<td>Signing Configuration</td>
<td>Select a JWT signing key. For example, DocuSign JTW Keys.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click Save.
   The Standard Claims and Custom Claims related lists display.
5. Select the JWT provider created for the DocuSign spoke.
6. Enter values for iss, sub, and aud in the Standard Claims related list. See the DocuSign Developer Center for instructions.
7. Insert a record in the Custom Claims related list and complete the form.

Custom Claims related list fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Claim Name</td>
<td>scope</td>
</tr>
<tr>
<td>Claim Value Type</td>
<td>string</td>
</tr>
<tr>
<td>Claim Value</td>
<td>signature impersonation</td>
</tr>
</tbody>
</table>

8. Click Update.

Register DocuSign as OAuth Provider
Use the information generated during DocuSign account configuration to register DocuSign as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

1. Navigate to System OAuth > Application Registry.
2. Click New.
   The system displays the message What kind of OAuth application?
3. Select Connect to a third party OAuth Provider.
   The system displays a blank Application Registries form.
4. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter DocuSign OAuth.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the integrator key you generated during the DocuSign account configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the client secret you generated during the DocuSign account configuration.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select JWT Bearer.</td>
</tr>
</tbody>
</table>
| Authorization URL      | • For developer sandbox environment, enter https://account-d.docusign.com/oauth/auth.  
                          | • For live production system, enter https://account.docusign.com/oauth/auth. |
| Token URL              | • For developer sandbox environment, enter https://account-d.docusign.com/oauth/token.  
                          | • For live production system, enter https://account.docusign.com/oauth/token. For more information see, see Post Go-Live and User Info Endpoint Reference in the DocuSign Developer Center documentation. |

5. Right-click the form header, and click Save.
   - The system validates the OAuth credentials and populates the Redirect URL.
   - The system populates OAuth Entity Profile with Grant Type as JWT Bearer. For example, OAuth Entity Profile is created with default Name, DocuSign OAuth default_profile

6. Insert a record in the OAuth Entity Scopes related list and fill the values.

   OAuth Entity Scopes related list fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>scope</td>
</tr>
<tr>
<td>OAuth Scope</td>
<td>signature impersonation</td>
</tr>
</tbody>
</table>

7. Copy the value from Redirect URL.
8. Click Update.
9. Login to your DocuSign account to edit the configuration of your custom DocuSign application. See the DocuSign Developer Center for instructions.

The instance can request OAuth 2.0 tokens for the spoke.
Note: When an OAuth token expires, the spoke automatically regenerates a new token in most cases. If a token expires and is not regenerated, an administrator can regenerate the spoke OAuth token.

Obtain consent
Obtain explicit consent for the ServiceNow application from DocuSign.
Role required: admin

Obtain consent for individuals

1. Navigate to System OAuth > Application Registry.
2. Open the record you had created for the DocuSign spoke.
3. Insert a record in the OAuth Entity Profiles related list and fill the values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>DocuSign OAuth default_profile_Auth_Code</td>
</tr>
<tr>
<td>Is default</td>
<td>true</td>
</tr>
<tr>
<td>Grant type</td>
<td>Authorization Code</td>
</tr>
</tbody>
</table>

4. Click the created OAuth Entity Profile.
5. Insert a record in the OAuth Entity Scopes related list and fill the values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>scope</td>
</tr>
<tr>
<td>OAuth Scope</td>
<td>signature impersonation</td>
</tr>
</tbody>
</table>

6. Create credential record associated with the OAuth Entity profile whose Grant type is Authorization Code.
   a. Navigate to Connections & Credentials > Credentials.
   b. Click New. The system displays the message What type of Credentials would you like to create?
   c. Select OAuth 2.0 Credentials.
   d. Fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter DocuSign Credentials Auth Code.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
</tbody>
</table>
### Create Credential records for the DocuSign spoke

Create Credential records for the DocuSign custom OAuth application you created during DocuSign account configuration. The DocuSign spoke connection and credential alias uses these credentials to authorize actions.

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   - The system displays the message **What type of Credentials would you like to create?**.
3. Select **OAuth 2.0 Credentials**.
   - The pop-up window displays a blank OAuth 2.0 Credentials form.
4. Fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter DocuSign Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom DocuSign application as an OAuth provider. For example, select DocuSign OAuth default_profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
</tbody>
</table>

5. **Save the record.**
6. Click the **Get OAuth Token** related link to generate the OAuth token.
7. Enter your DocuSign user name and password to provide the consent.

### Obtain consent for an organization administrator

See DocuSign Developer documentation (Admin consent for internal applications) for instructions to obtain consent for an organization administrator.

*Create Credential records for the DocuSign spoke*

Create Credential records to the DocuSign custom OAuth application you created during DocuSign account configuration. The DocuSign spoke connection and credential alias uses these credentials to authorize actions.

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   - The system displays the message **What type of Credentials would you like to create?**.
3. Select **OAuth 2.0 Credentials**.
   - The pop-up window displays a blank OAuth 2.0 Credentials form.
4. Fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter DocuSign Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom DocuSign application as an OAuth provider. For example, select DocuSign OAuth default_profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
</tbody>
</table>
Create Connection records for the DocuSign spoke
Create Connection records to your DocuSign account. The DocuSign spoke connection and credential alias uses these connections to perform actions in DocuSign.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for DocuSign.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

- **Name**: Enter any name to uniquely identify the connection record. For example, enter DocuSign Connection.
- **Credential**: Select the Credential record you created for DocuSign. For example, select DocuSign Credentials.
- **Connection URL**: Enter these values:
  - For demo environment, enter `https://demo.docusign.net`.
  - For live production system, enter the Base URI such as `na2.docusign.net` or `eu.docusign.net`. For instructions on obtaining the base URI, see Post Go-Live and User Info Endpoint Reference in the DocuSign Developer Center documentation.

5. Click **Submit**.

Synchronize ServiceNow with DocuSign to access DocuSign accounts, templates, and envelopes from the DocuSign spoke. See Synchronize DocuSign with ServiceNow.

Configure DocuSign webhook
Configure the webhook in your DocuSign account to enable DocuSign to send data to ServiceNow when a recipient signs a document.

Role required: admin

1. Connect a custom configuration to enable your DocuSign application to share events and data with your ServiceNow instance.
2. Add your ServiceNow instance URL in this format: `https://{instance-name}.service-now.com/api/sn_docusign_spoke/docusign_webhook`.
3. Include basic authorization in the header and add your ServiceNow credentials.
4. Enable DocuSign to share envelope events with ServiceNow.
   - Envelope Sent
   - Envelope Delivered
   - Envelope Signed/Completed
   - Envelope Declined
   - Envelope Voided

**Synchronize DocuSign with ServiceNow**

Synchronize ServiceNow with DocuSign to access DocuSign accounts, templates, and envelopes from the DocuSign spoke.

Role required: admin
- Request IntegrationHub subscription
- Activate DocuSign spoke
- Set up DocuSign spoke

Schedule a job to synchronize DocuSign with your ServiceNow instance daily, or synchronize data as needed.

1. Required: Schedule a job to synchronize DocuSign data with your ServiceNow instance.
   a) Navigate to DocuSign > Scheduled Job.
      The Get Accounts & Templates scheduled job opens.
   b) Select Active.

   The DocuSign spoke synchronizes accounts, templates, and envelopes daily.

2. Required: Synchronize DocuSign data as needed with a UI action.
   a) Navigate to DocuSign > Accounts.
      The Accounts [sn_docusign_spoke_accounts] table opens.
   b) Click the Get Accounts related link.

   The system synchronizes all accounts linked through an OAuth Credential record and populates the Templates and Envelopes tables with DocuSign data. Use template and envelope records when constructing flows.

**Activate DocuSign spoke catalog items**

Trigger events in DocuSign when an item is requested in the Service Catalog. For example, The Send a Document for Digital Signature catalog item triggers a sample flow that sends a DocuSign document to a designated recipient.

Role required: admin
- Request IntegrationHub subscription
- Activate DocuSign spoke
- Activate the Flow Designer support for the Service Catalog (com.glideapp.servicecatalog.flow_designer) plugin

The DocuSign spoke adds catalog items for use with the DocuSign spoke sample flows. Before triggering a DocuSign spoke sample flow, activate these catalog items.
<table>
<thead>
<tr>
<th>Catalog item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send a Document for Digital Signature</td>
<td>Sends a document for digital signature in DocuSign.</td>
</tr>
<tr>
<td>Demonstrate Template - Send Job Offer to Candidate</td>
<td>Sends a job offer using a DocuSign template.</td>
</tr>
</tbody>
</table>

1. Navigate to **Service Catalog > Maintain Items**.
2. Search for and select **Send a Document for Digital Signature**.
3. Click **Activate**.
4. Open the record, **Send a Document for Digital Signature**.
5. In the **Process Engine** tab, select **Send a Document for Digital Signature** for **Flow**.
6. Search for and select **Demonstrate Template - Send Job Offer to Candidate**.
7. Click **Activate**.
8. Open the record, **Demonstrate Template - Send Job Offer to Candidate**.
9. In the **Process Engine** tab, select **Send employment offer to candidate using DocuSign template** for **Flow**.

When one of these items is requested in the Service Catalog, the associated DocuSign spoke sample flow triggers and performs actions in DocuSign.

### Change the DocuSign API version

By default, the DocuSign spoke sends REST API requests to DocuSign API v2. For forward compatibility and to take advantage of DocuSign’s newer API, you can update a connection attribute to send API requests to DocuSign API v2.1.

**Role required:** admin

To understand the difference between the two APIs, see the [DocuSign Developer site](https://developer.docusign.com).

1. Navigate to **DocuSign > Connection Aliases**.
2. Open the connection alias that you want to update the version for.
   - Only requests sent using this alias use the new API version. For example, if you want to update the API version for all requests and your implementation uses multiple connection aliases, you must update each connection alias.
3. In the **Connection Attributes** related list, add or edit the **API Version** record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>String</td>
</tr>
<tr>
<td>Label</td>
<td>API Version</td>
</tr>
<tr>
<td>Column name</td>
<td>api_version</td>
</tr>
<tr>
<td>Default value</td>
<td>v2.1</td>
</tr>
</tbody>
</table>

4. Save or submit the record.

When the DocuSign spoke makes an API request, it uses the API version designated in the connection attribute **Default value** field.

### How to automate on-demand signing requests

Send DocuSign on-demand signing requests using information in your ServiceNow instance. Send signing requests within an email, or create an embedded signing URL to use in an application.
Role required: admin
- Request IntegrationHub subscription
- Activate DocuSign spoke
- Set up DocuSign spoke

**Note:** Customize flows in Flow Designer based on your requirements.

1. In Flow Designer, create a flow and a trigger.
2. Add one of the following actions to send a signing request:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Adhoc Signature Request To User</td>
<td>Send a document to a single user for signing using email or an embedded signing URL. To send an embedded signing URL, select <strong>Use Embedded Signing</strong> and add the recipient to the <strong>Embedded Signing Recipient [User]</strong> field.</td>
</tr>
<tr>
<td>Send Adhoc Signature Request To Users</td>
<td>Send a document to multiple users for signing using email or an embedded signing URL. To send an embedded signing URL, select <strong>Use Embedded Signing</strong>.</td>
</tr>
</tbody>
</table>

3. Optional: If using embedded signing, add the **Get Embedded Signing URL** action to get the signing URL as an action output. You can then embed the URL in an application.
4. Optional: To pause the flow until the specified document is signed or rejected, select the **Wait for Signature from DocuSign** action.

The system sends the document to the recipient or list of recipients, or generates an embedded signing URL. The recipient details are auto-populated in the document. The system creates an envelope record in the **Envelopes** table.

**How to automate signing requests using templates**

Send DocuSign signing requests using DocuSign templates and information in your ServiceNow instance by creating flows in Flow Designer. For example, **Send employee offer**.

Role required: admin
- Request IntegrationHub subscription
- Activate DocuSign spoke
- Set up DocuSign spoke

**Note:** Customize flows based on your requirements.

1. In DocuSign, create document templates and specify recipient roles. For example, **Candidate** and **Manager**. The system retrieves other recipient details such as name and email, when the flow is triggered.
2. In Flow Designer, create a new flow.
3. Specify **TRIGGER** to initiate the flow.
4. Specify the **ACTIONS** to be performed during the flow and provide recipient details. The actions include:
   - Create Draft Envelope from Template
   - Get Recipient ID by Role Name
   - Add Recipient to Envelope
   - Get Recipient ID by Role Name
• Add Recipient to Envelope
• Get Field ID
• Set Field Value
• Send Envelope
• Get Field Value

5. Optional: To pause the flow until the specified document is signed or rejected, select the **Wait for Signature from DocuSign** action.
   • The selected document or Embedded Signing URL is sent to the recipients for signing. While signing the document, the recipient details are auto-populated.
   • An envelope record is created in the **Envelopes** table. The Envelope status and other details are updated.

### How to separate DocuSign account data

Restrict access to DocuSign data based on a user's role. For example, your company may have one DocuSign account used by the HR team and another used by the Legal team. To keep the data separate between these two accounts, you can create a role for each account and add it to the accounts record.

• Request IntegrationHub subscription
• Activate DocuSign spoke
• Create connection aliases for additional DocuSign accounts
• Set up DocuSign spoke

1. Create a role for each DocuSign account that you want to restrict access to.
   a) Navigate to **System Security > Users and Groups > Roles**.
   b) In the Roles [sys_user_role] table, select **New**.
   c) Check that the value of the **Application** field is **DocuSign Spoke**. If a different scope is listed, change the scope to **DocuSign Spoke**.
   d) In the **Suffix** field, add a name to indicate the account that the role is for. For example, **Legal**.
   e) Save the record.
   f) Note the name of the role you just created. For example, **sn_docusign_spoke.legal**.

2. Add the role to the associated account in the accounts table.
   a) Navigate to **DocuSign > Accounts**.
   b) Open the account record that you want to restrict access to.
   c) In the **Role** field, add the associated role.
   d) Click **Update**.

3. Grant the role to the desired users.
   a) Navigate to **System Security > Users and Groups > Users**.
   b) Open the record for the user you want to provide access.
   c) Add the role you created to the Roles related list.

Only users with the designated role have access to DocuSign data associated with the account.
F5 BIG-IP spoke
Manage servers and pools in the F5 BIG-IP system.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

Spoke dependencies
If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

_i Note:_ Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported version
BIG-IP 13.1.0.

Spoke flows
The F5 BIG-IP spoke provides sample flows in the draft state to demonstrate automating F5 tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Traffic Management Using F5 Big-IP</td>
<td>Creates a virtual server, associates it to a pool, and adds pool member in the BIG-IP system from a ServiceNow Service Catalog request.</td>
</tr>
</tbody>
</table>

Spoke subflows
The F5 BIG-IP spoke provides sample subflows to demonstrate automating F5 tasks. Available sample subflows include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pool Management</td>
<td>Create Pool</td>
<td>Creates a pool in the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Add Pool Member</td>
<td>Creates a pool member in the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Check Pool</td>
<td>Checks pool health in BIG-IP system. Returns whether the pool is available, unavailable, offline, or if the status is unknown.</td>
</tr>
<tr>
<td></td>
<td>Delete Pool</td>
<td>Deletes a pool from the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Disable Pool Member</td>
<td>Disables a pool member in the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Enable Pool Member</td>
<td>Enables a pool member of a specified pool in the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Get Pool Members</td>
<td>Retrieves the list of members of a specified pool from the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Remove Pool Member</td>
<td>Deletes a pool member in the BIG-IP system.</td>
</tr>
<tr>
<td>Server Management</td>
<td>Add Profile to Virtual Server</td>
<td>Adds a profile to a virtual server in the BIG-IP system. Profiles enable you to control network traffic. For example, you can enable HTTP connections to the virtual server.</td>
</tr>
<tr>
<td></td>
<td>Create Virtual Server</td>
<td>Creates a virtual server in the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Delete Virtual Server</td>
<td>Deletes a virtual server from the BIG-IP system.</td>
</tr>
<tr>
<td></td>
<td>Update Virtual Server</td>
<td>Updates virtual server attributes in the BIG-IP system.</td>
</tr>
</tbody>
</table>
Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Credentials and connection information.

This spoke uses this alias record to authorize actions.

<table>
<thead>
<tr>
<th>Connection &amp; Credential alias</th>
<th>Description</th>
<th>Connection alias requirements</th>
</tr>
</thead>
</table>
| F5_BIG_IP                     | Connection to the F5 BIG-IP system. | • Connection type: HTTP  
• Connection URL: URL of the host machine where the F5 server is installed. |

To use the spoke connection alias, create an associated Connection record and an associated Credential record.

MID Server requirements

These actions use REST calls, which can run on a MID Server. Use the connection record associated with the F5 BIG-IP alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

Set up F5 BIG-IP spoke

Integrate the ServiceNow instance and F5 using basic authentication to authenticate ServiceNow requests.

• Request IntegrationHub subscription  
• Activate F5 BIG-IP spoke  
• Role required: admin

Create Credential records for the F5 BIG-IP spoke

Create Credential records to the F5 BIG-IP server. The F5 BIG-IP spoke connection and credential alias uses these credentials to authorize actions.

1. Navigate to Connections & Credentials > Credentials.  
2. Click New.  
The system displays the message What type of Credentials would you like to create?.  
3. Select Basic Auth Credentials.  
A blank Basic Auth Credentials form displays.  
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter F5 Credentials.</td>
</tr>
<tr>
<td>User name</td>
<td>Your F5 BIG-IP user name.</td>
</tr>
<tr>
<td>Password</td>
<td>Your F5 BIG-IP password.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
</tbody>
</table>
Create Connection records for the F5 BIG-IP spoke
Create Connection records to your F5 BIG-IP account. The F5 BIG-IP spoke connection and credential alias uses these connections to perform actions on the F5 BIG-IP server.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for F5_BIG_IP.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter F5 Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for F5. For example, select F5 Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>The URL of the host machine where the F5 BIG-IP server is installed.</td>
</tr>
</tbody>
</table>
5. Click Submit.

First Advantage spoke v1.0.1
Manage and track the background verifications of candidates using First Advantage from your ServiceNow instance. Manage users, accounts, candidates, invites, and orders in First Advantage from your ServiceNow instance.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

IntegrationHub subscription
This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

Note: First Advantage spoke is compatible with ServiceNow version, New York with Patch 6 and later.
Supported versions

This spoke was built for First Advantage API version v1.1, but may be compatible with later versions.

Spoke requirements

- First Advantage account
- API key

**Note:** Contact the First Advantage team to obtain the API key.

- Account ID

**Note:** Contact the First Advantage team to obtain the Account ID.

Spoke flows

The First Advantage spoke provides sample flows to demonstrate automating the First Advantage tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Advantage - Candidate Background Verification using Invite</td>
<td>Initiates background check of the candidate using invite. Sends a request to the candidate to complete an application. For information about creating a case, see Create a case in First Advantage from ServiceNow.</td>
</tr>
<tr>
<td>First Advantage - Candidate Background Verification using Order</td>
<td>Initiates background check of the candidate using order. An order record is created and request to provide essential details is sent to the candidate. For information about creating a case, see Create a case in First Advantage from ServiceNow.</td>
</tr>
<tr>
<td>First Advantage - (Order As) Candidate Background Verification using Order</td>
<td>Initiates background check of the candidate using order and places order on behalf of the required user.</td>
</tr>
<tr>
<td>First Advantage - (Order As) Candidate Background Verification using Invite</td>
<td>Initiates background check of the candidate using invite and places order on behalf of the required user.</td>
</tr>
</tbody>
</table>

Spoke subflows

The First Advantage spoke provides a sample subflow to demonstrate automating First Advantage tasks. To customize the sample subflow, copy it to a new application scope. Available sample subflow is, Get Packages. The subflow retrieves packages in First Advantage and stores the details in the Packages table.

Spoke actions

The First Advantage spoke provides actions manage accounts, candidates, invites, orders, and users when events occur in ServiceNow. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Get Account Details</td>
<td>Retrieves details of the First Advantage account.</td>
</tr>
<tr>
<td></td>
<td>Get Account Packages</td>
<td>Retrieves the details of all the packages in an account.</td>
</tr>
<tr>
<td></td>
<td>Get Account Profiles</td>
<td>Retrieves the details of all profiles in an account.</td>
</tr>
<tr>
<td></td>
<td>Get Account Users</td>
<td>Retrieves the details of all users in an account.</td>
</tr>
<tr>
<td></td>
<td>Create New Candidate</td>
<td>Creates a candidate profile for background verification.</td>
</tr>
<tr>
<td></td>
<td>Get Candidate By Candidate ID</td>
<td>Retrieves the details of the required candidate.</td>
</tr>
<tr>
<td></td>
<td>Get Documents For A Specific Candidate</td>
<td>Retrieves the documents associated with the required candidate.</td>
</tr>
<tr>
<td></td>
<td>Get Monitoring Product Details For A Specific Candidate</td>
<td>Retrieves the details of the monitoring product for the required candidate.</td>
</tr>
<tr>
<td></td>
<td>Update Candidate Details</td>
<td>Updates the details of a candidate profile.</td>
</tr>
<tr>
<td>Invite Management</td>
<td>Create Invite</td>
<td>Create an invite for the candidate to fill the application.</td>
</tr>
<tr>
<td></td>
<td>Get Invite Status By Applicant ID</td>
<td>Retrieves the latest status of the invite for the required applicant.</td>
</tr>
<tr>
<td></td>
<td>Get Invite View Link By Application ID</td>
<td>Retrieves a secure link to access the profile that the candidate must complete.</td>
</tr>
<tr>
<td>Order Management</td>
<td>Create Order</td>
<td>Creates a First Advantage screening order.</td>
</tr>
<tr>
<td></td>
<td>Get Order Report By Order ID</td>
<td>Retrieves the completed order report for the required order.</td>
</tr>
<tr>
<td></td>
<td>Get Order Status By Order ID</td>
<td>Retrieves the latest order status for the required order.</td>
</tr>
<tr>
<td>User Management</td>
<td>Activate User</td>
<td>Activates the required user.</td>
</tr>
<tr>
<td></td>
<td>Create User</td>
<td>Creates a user profile.</td>
</tr>
<tr>
<td></td>
<td>Deactivate User</td>
<td>Deactivates the required user.</td>
</tr>
<tr>
<td></td>
<td>Update User Password</td>
<td>Updates the password of the required user.</td>
</tr>
<tr>
<td></td>
<td>Update User Profile</td>
<td>Updates information in the profile of the required user.</td>
</tr>
</tbody>
</table>
Spoke module

The First Advantage spoke adds a First Advantage spoke module to your ServiceNow instance. The First Advantage spoke synchronizes and stores information about First Advantage cases, tasks, employee tasks, order tasks, and packages.

The First Advantage spoke includes these modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>Enables you to view the details of all accounts available in First Advantage. To view the account details, you must set up the spoke and synchronise the accounts.</td>
</tr>
<tr>
<td>FADV Webhook Client Details</td>
<td>Enables you to set up First Advantage webhook by providing key for the First Advantage webhook client.</td>
</tr>
<tr>
<td>Create New First Advantage Case</td>
<td>Enables you to initiate the background check of the required candidate using invite or order from ServiceNow.</td>
</tr>
<tr>
<td>First Advantage Cases</td>
<td>Enables you to view list of all First Advantage cases created using invite and order.</td>
</tr>
<tr>
<td>Packages</td>
<td>Enables you to view the details of all packages available in First Advantage. To view the package details, you must set up the spoke and synchronise the packages.</td>
</tr>
<tr>
<td>Order Tasks</td>
<td>Enables you to view list of all First Advantage order records.</td>
</tr>
<tr>
<td>Employee Tasks</td>
<td>Enables you to view list of all First Advantage cases created using invite.</td>
</tr>
</tbody>
</table>

The First Advantage spoke includes the these tables:

- First Advantage Task [sn_fadv_spoke_first_advantage_task]
- First Advantage Employee Task [sn_fadv_spoke_first_advantage_employee_task_table]
- Packages [sn_fadv_spoke_packages]
- FADV Webhook Client Details [sn_fadv_spoke_webhook_client_details]

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Advantage Task</td>
<td>Details of all the First Advantage order records.</td>
</tr>
<tr>
<td>First Advantage Employee Task</td>
<td>Details of all the First Advantage invite records.</td>
</tr>
<tr>
<td>Packages</td>
<td>First Advantage packages that are synchronized with ServiceNow.</td>
</tr>
<tr>
<td>FADV Webhook Client Details</td>
<td>Client details to set up the First Advantage webhook.</td>
</tr>
</tbody>
</table>

Spoke user roles

- First Advantage admin
First Advantage user

Only users with the First Advantage admin role can view the **FADV Webhook Client Details** module.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see [Credentials and connection information](#).

**Set up the First Advantage spoke**

Integrate the ServiceNow instance with your First Advantage account using an API key to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Activate the First Advantage spoke
- Role required: admin

Create Credential record for the First Advantage spoke

Create Credential records to the First Advantage spoke. The First Advantage spoke connection and credential alias uses these credentials to authorize actions.

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   The system displays the message **What type of Credentials would you like to create?**.
3. Select **API Key Credentials**.
   A blank API Key Credentials form displays.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter FADV Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>API Key</td>
<td>API key generated for your First Advantage instance.</td>
</tr>
</tbody>
</table>

   ![Note](image)
   
   **Note:** Contact the First Advantage team to obtain the API key.

5. Click **Submit**.

Create Connection record for the First Advantage spoke

Create a Connection record to the First Advantage API. The First Advantage spoke connection and credential alias uses these connections to perform actions in First Advantage.

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the record for **First Advantage**.
3. From the **Connections** tab, click **New**.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter FADV Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for First Advantage. For example, select FADV Credentials.</td>
</tr>
</tbody>
</table>

5. In the Attributes tab, enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distribution Email</td>
<td>Distribution email of your organization.</td>
</tr>
<tr>
<td>u_version</td>
<td>v1.1</td>
</tr>
</tbody>
</table>

**Note:** If you are using any other version of First Advantage, specify the version number.

6. Click Submit.
8. Open for the record for First Advantage.
9. Click the Connection Attributes tab.
10. Modify the default values of the connection attributes records as per your requirement.

<table>
<thead>
<tr>
<th>Connection Attributes record</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distribution Email</td>
<td>Distribution email of your organization.</td>
</tr>
<tr>
<td>Version</td>
<td>v1.1</td>
</tr>
</tbody>
</table>

**Note:** If you are using any other version of First Advantage, specify the version number.

---

Create First Advantage states in your ServiceNow instance

Create First Advantage states to be displayed in the **State** list in your ServiceNow instance.

Role required: admin

Create the Draft, Ready, and In Progress states

Create the Draft, Ready, and In Progress states in the Task [task] table.

1. In the Filter navigator, enter `sys_choice.list`.
   The records in the Choice [sys_choice] table are displayed.
2. Click **New**.
3. On the form, fill these values and create three records for the Draft state.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Task [task]</td>
</tr>
<tr>
<td>Element</td>
<td>state</td>
</tr>
<tr>
<td>Label</td>
<td>Draft</td>
</tr>
<tr>
<td>Value</td>
<td>137</td>
</tr>
</tbody>
</table>

**Note:**
- Ensure that you provide the exact numbers in the **Value** field as mentioned here. The spoke flows will not be triggered if there is any change in these numbers.
- Ensure that the record is created in the **Global** application.

4. Click **Submit**.
5. Similarly, create records for the Ready and In Progress states.

**Record 2 - Ready state**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Task [task]</td>
</tr>
<tr>
<td>Element</td>
<td>state</td>
</tr>
<tr>
<td>Label</td>
<td>Ready</td>
</tr>
<tr>
<td>Value</td>
<td>173</td>
</tr>
</tbody>
</table>

**Record 3 - In Progress state**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Task [task]</td>
</tr>
<tr>
<td>Element</td>
<td>state</td>
</tr>
<tr>
<td>Label</td>
<td>In Progress</td>
</tr>
<tr>
<td>Value</td>
<td>181</td>
</tr>
</tbody>
</table>

**Note:**
- Ensure that you provide the exact numbers in the **Value** field as mentioned here. The spoke flows will not be triggered if there is any change in these numbers.
- Ensure that the record is created in the **Global** application.

The Draft, Ready, and In Progress states are created in the Task [task] table

Create the Complete and Cancelled states
Create the Complete and Cancelled states in the First Advantage Task
[sn_fadv_spoke_first_advantage_task] table.

1. Navigate to First Advantage Spoke > Order Tasks.
2. Click New.

   **Note:** Ensure that the record is created in the First Advantage application.

3. Right-click State and click Configure Choices.
4. Perform these steps to create the Cancelled state:
   a) Enter Cancelled in New item text.
   b) Enter 149 in Numeric value.

   **Note:** Ensure that you provide the exact numbers in the Numeric value field as mentioned here. The spoke flows will not be triggered if there is any change in these numbers.
   c) Click Add.
   d) Click Save.

5. Perform these steps to create the Complete state:
   a) Enter Complete in New item text.
   b) Enter 127 in Numeric value.

   **Note:** Ensure that you provide the exact numbers in the Numeric value field as mentioned here. The spoke flows will not be triggered if there is any change in these numbers.
   c) Click Add.
   d) Click Save.

The Complete and Cancelled states are created in the First Advantage Task
[sn_fadv_spoke_first_advantage_task] table.

Create the Complete - Success and Complete - Deal Broken states
Create the Complete - Success and Complete - Deal Broken states in the First Advantage Employee Task
[sn_fadv_spoke_first_advantage_employee_task_table] table.

1. Navigate to First Advantage Spoke > Employee Task.
2. Click New.

   **Note:** Ensure that the record is created in the First Advantage application.

3. Right-click State and click Configure Choices.
4.  Perform these steps to create the Cancelled state:
   a) Enter Complete - Success in New item text.
   b) Enter 161 in Numeric value.
      
      **Note:** Ensure that you provide the exact numbers in the Numeric value field as mentioned here. The spoke flows will not be triggered if there is any change in these numbers.
   c) Click Add.
   d) Click Save.

5.  Perform these steps to create the Complete state:
   a) Enter Complete - Deal Broken in New item text.
   b) Enter 117 in Numeric value.
      
      **Note:** Ensure that you provide the exact numbers in the Numeric value field as mentioned here. The spoke flows will not be triggered if there is any change in these numbers.
   c) Click Add.
   d) Click Save.

The Complete - Success and Complete - Deal Broken states are created in the First Advantage Employee Task [sn_fadv_spoke_first_advantage_employee_task_table] table.

**Set up First Advantage webhooks**
Receive invite and order event updates at your ServiceNow instance by setting up the webhooks.

Role required: admin

Provide key in your ServiceNow instance

Set up the First Advantage webhook by providing key for the First Advantage webhook client.

- Generate a secure key as per your requirement and record the value. For example, a base64 encoded key.
- Role required: admin

1.  Navigate to **First Advantage Spoke > FADV Webhook Client Details**.
2.  Click **New**.
3.  On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record.</td>
</tr>
<tr>
<td>Authorization Key</td>
<td>Key you had generated as per your requirement.</td>
</tr>
</tbody>
</table>

4.  Click **Submit**.

**Access API endpoints**

Access the API endpoint for the invite and order events and share the required details with First Advantage to set up the webhooks.
Role required: admin
1. Navigate to System Web Services > Scripted REST APIs.
2. Open the record for the First Advantage spoke. For example, First Advantage Webhook.
3. In the Resources tab:
   a) Open the record for the invite event. For example, Invite Status.
   b) Copy and record the path provided in Resource path. For example, /api/sn_fadv_spoke/fadv/invite_status.
   c) Open the record for the order event. For example, Order Status.
   d) Copy and record the path provided in Resource path. For example, /api/sn_fadv_spoke/fadv/order_status.

Contact First Advantage to setup webhooks for your ServiceNow instance. For this, share these details with First Advantage:

- Custom header in this format: fadvKey <authorization-key>.

**Note:**
- Ensure that the custom header is in this format only. The spoke flows will not be triggered if there is any change.
- Provide the same key you had earlier provided in First Advantage Spoke > FADV Webhook Client Details.
- Use the same case as mentioned here: fadvKey.

- API endpoint for the invite events in this format: <ServiceNow-instance-URL>/api/sn_fadv_spoke/fadv/invite_status
- API endpoint for the order events in this format: <ServiceNow-instance-URL>/api/sn_fadv_spoke/fadv/order_status

Synchronise First Advantage packages with ServiceNow
Store the details of the First Advantage accounts and packages by synchronizing First Advantage accounts and packages with ServiceNow.

Role required: First Advantage admin
1. Navigate to First Advantage Spoke > Accounts.
2. Click New.
3. On the form, fill in the values.

   **Account form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Account</td>
<td>Option to specify that the account is a primary account. Select the check box.</td>
</tr>
<tr>
<td>Account ID</td>
<td>ID of the primary account.</td>
</tr>
<tr>
<td>Account Name</td>
<td>Name of the primary account.</td>
</tr>
</tbody>
</table>

4. Click Submit.
The primary account is created and the record is displayed.
5. Navigate to First Advantage Spoke > Accounts.
6. Click the Get Accounts related list.
7. Navigate to **First Advantage Spoke > Packages**.  
8. Click the **Get Packages** related link.

The First Advantage account and package details are retrieved.

**Note:** Only users with the FADV admin role can synchronize the account and package details. Users with FADV user role can only view the retrieved details.

### Create a case in First Advantage from ServiceNow

Initiate the background check of the required candidate using invite or order from ServiceNow.

- **Set up the First Advantage spoke**  
- **Synchronise First Advantage packages with ServiceNow**  
- **Create users in the User [sys_user] table. Background check can be performed only for these users.**  
- **Role required:** First Advantage admin or First Advantage admin user

1. Navigate to **First Advantage Spoke > Create New First Advantage Case**.  
   Form to provide the First Advantage case details is displayed.
2. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Distribution Email for getting invite email from First Advantage</td>
<td>Option to send invitation email to all users in the distribution email.</td>
</tr>
<tr>
<td>Select User</td>
<td>User in the User [sys_user] table.</td>
</tr>
<tr>
<td>First Name</td>
<td>First name of the selected user. The value is auto-populated based on the user selected in <strong>Select User</strong>.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Last name of the selected user. The value is auto-populated based on the user selected in <strong>Select User</strong>.</td>
</tr>
<tr>
<td>Email</td>
<td>Email address of the selected user. The value is auto-populated based on the user selected in <strong>Select User</strong>.</td>
</tr>
<tr>
<td>Select An Account</td>
<td>First Advantage account to perform the background check.</td>
</tr>
<tr>
<td>Select A Package</td>
<td>First Advantage package to perform the background check.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Brief description about the background check.</td>
</tr>
<tr>
<td>Agent Name</td>
<td>Agent to perform the background check.</td>
</tr>
</tbody>
</table>
### Field: Send Invite link
Option to send an invite email. When selected, a request to complete an application is sent to the candidate through an invite email.

If this option isn't selected, an order email is sent to the user. An order record is created and request to provide essential details is sent to the candidate.

**Note:**
- When the Send Invite link option is selected, an order is created only after the candidate has filled the application form.
- When the Send Invite link option isn't selected, an order is immediately created.

Events updates can be accessed in your ServiceNow instance.

### Field: Use "Order As"
Option to place order on behalf of the required user.

### Field: Email (Order As)
Email ID of the required user. This field is available only when the Use "Order As" check box is selected.

### Field: Account ID (Order As)
Account ID of the required user. This field is available only when the Use "Order As" check box is selected.

### Field: User ID (Order As)
User ID of the required user. This field is available only when the Use "Order As" check box is selected.

### 3. Click Submit.
A First Advantage task is created in your ServiceNow instance with State as Draft. The case can be accessed by navigating to First Advantage Spoke > First Advantage Cases.

### Initiate background verification in First Advantage from ServiceNow using invite
Initiate background verification of the required candidate by sending a request to complete an application through an invite email.

- Create a case in First Advantage from ServiceNow

  **Note:** Ensure that the Send Invite link option is selected and the Use "Order As" option isn't selected.

- Role required: First Advantage admin or First Advantage user

  1. Navigate to First Advantage Spoke > First Advantage Cases.
  2. Search for the required task.
  3. Ensure that the Send Invite link option is selected and the Use "Order As" option isn't selected.
4. Change the **State** of the task from **Draft** to **Ready**.
   - The First Advantage - Candidate Background Verification using Invite flow is triggered.
   - **State** is changed to **In Progress**.
   - In the **Employee Tasks** tab, a record is created and its details such as **Number**, **Invite ID** and so on, are populated. Open the record to access details such as **Invite URL**, **Candidate ID**, and so on. Also, real-time updates are displayed here.

   **Note:** The **Employee Tasks** tab displays all the invite records created for the user.

   - In the **Order History** tab, a record is created and its details such as **Number**, **Short Description** and so on, are populated.

   **Note:** The **Order History** tab displays all the order records created for the user.

   - Real-time updates and System Administrator events are displayed in the **Order Details** tab.

   **Note:** **Order ID** is populated only after the invite is executed successfully. For example, **Order ID** isn't populated if the candidate has declined to complete the application form.

   - An invite email is sent to the candidate.

After accessing the invite email, candidate can either complete the application form or decline. If candidate fills and submits the application form, First Advantage approves, cancels, or rejects the task after performing the background verification.

- The status and all other details can be accessed in real-time by navigating to **First Advantage Spoke > Employee Tasks**.
- Guest events are displayed in the respective First Advantage Employee Task record.

**Note:**
- You must set up the webhooks to receive the guest event updates. See Set up First Advantage webhooks for information on setting up the webhooks.
- If the candidate has declined the request for background verification, the Order record isn't created for the task.

**Initiate background verification in First Advantage from ServiceNow using order**

Initiate background verification of the required candidate by sending an email requesting for the essential information.

- **Create a case in First Advantage from ServiceNow**

  **Note:** Ensure that the **Send Invite link** and **Use "Order As"** options aren't selected.

- Role required: First Advantage admin or First Advantage user

An order is initiated when First Advantage has all basic information about the candidate and requires only some essential sensitive information.

1. Navigate to **First Advantage Spoke > First Advantage Cases**.
2. Search for the required task.
3. Ensure that the **Send Invite link** and **Use "Order As"** options aren't selected.
4. Change the **State** of the task from **Draft** to **Ready**.
- The First Advantage - Candidate Background Verification using Order flow is triggered.
- **State** is changed to **In Progress**.
- In the **Order History** tab, a record is created and its details such as **Order ID**, **Number**, **Short Description** and so on, are populated.
- Real-time updates and System Administrator events are displayed in the **Order Details** tab.

  **Note:** The **Order History** tab displays all the order records created for the user.

- An order email is sent to the candidate.

A mail is sent to candidate requesting only the sensitive information. Real-time updates and guest events are displayed in the **Order Details** tab. First Advantage approves, cancels, or rejects the task after performing the background verification.

  **Note:** You must set up the webhooks to receive the guest event updates. See **Set up First Advantage webhooks** for information on setting up the webhooks.

### Initiate background verification in First Advantage from ServiceNow using invite on behalf of another user

Initiate background verification of the required candidate by sending a request on behalf of another user to complete an application through an invite email.

- Create a case in First Advantage from ServiceNow

  **Note:** Ensure that the **Send Invite link** and **Use "Order As"** options are selected.

- Role required: First Advantage admin or First Advantage user

1. Navigate to **First Advantage Spoke > First Advantage Cases**.
2. Search for the required task.
3. Ensure that the **Send Invite link** and **Use "Order As"** options are selected.
4. Change the **State** of the task from **Draft** to **Ready**.

   - The First Advantage - Candidate Background Verification using Invite flow is triggered.
   - **State** is changed to **In Progress**.
   - In the **Employee Tasks** tab, a record is created and its details such as **Number**, **Invite ID** and so on, are populated. Open the record to access details such as **Invite URL**, **Candidate ID**, and so on. Also, real-time updates are displayed here.

     **Note:** The **Employee Tasks** tab displays all the invite records created for the user.

   - In the **Order History** tab, a record is created and its details such as **Number**, **Short Description** and so on, are populated.

     **Note:** The **Order History** tab displays all the order records created for the user.

   - Real-time updates and System Administrator events are displayed in the **Order Details** tab.

     **Note:** **Order ID** is populated only after the invite is executed successfully. For example, **Order ID** isn't populated if the candidate has declined to complete the application form.

   - An invite email is sent to the candidate.
After accessing the invite email, candidate can either complete the application form or decline. If candidate fills and submits the application form, First Advantage approves, cancels, or rejects the task after performing the background verification.

- The status and all other details can be accessed in real-time by navigating to **First Advantage Spoke > Employee Tasks**.
- Guest events are displayed in the respective First Advantage Employee Task record.

**Note:**
- You must set up the webhooks to receive the guest event updates. See Set up First Advantage webhooks for information on setting up the webhooks.
- If the candidate has declined the request for background verification, the Order record isn’t created for the task.

**Initiate background verification in First Advantage from ServiceNow using order**

Initiate background verification of the required candidate by sending an email requesting for the essential information on behalf of the required user.

- Create a case in First Advantage from ServiceNow

  **Note:** Ensure that the **Send Invite link** option isn’t selected and the **Use "Order As"** option is selected.

- Role required: First Advantage admin or First Advantage user

An order is initiated when First Advantage has all basic information about the candidate and requires only some essential sensitive information.

1. Navigate to **First Advantage Spoke > First Advantage Cases**.
2. Search for the required task.
3. Ensure the **Send Invite link** option isn’t selected and the **Use "Order As"** option is selected.
4. Change the **State** of the task from **Draft** to **Ready**.

- The First Advantage - Candidate Background Verification using Order flow is triggered.
- **State** is changed to **In Progress**.
- In the **Order History** tab, a record is created and its details such as **Order ID**, **Number**, **Short Description** and so on, are populated.
- Real-time updates and System Administrator events are displayed in the **Order Details** tab.

  **Note:** The **Order History** tab displays all the order records created for the user.

- An order email is sent to the candidate.

A mail is sent to candidate requesting only the sensitive information. Real-time updates and guest events are displayed in the **Order Details** tab. First Advantage approves, cancels, or rejects the task after performing the background verification.

**Note:** You must set up the webhooks to receive the guest event updates. See Set up First Advantage webhooks for information on setting up the webhooks.
HipChat spoke

The HipChat spoke provides actions which post messages and ServiceNow incident, problem, and change record details to a HipChat conversation.

IntegrationHub subscription

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

HipChat actions

The HipChat spoke is an available integration through IntegrationHub. You can specify the following HipChat actions within a flow:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post a Message</td>
<td>Send a message to a HipChat room. Specify the Room Notification URL, Auth Token, and Message to send.</td>
</tr>
<tr>
<td>Post Change Details</td>
<td>Send details about a ServiceNow change record to a HipChat room. Specify the Room Notification URL, Auth Token, and Change record to send.</td>
</tr>
<tr>
<td>Post Incident Details</td>
<td>Send details about a ServiceNow incident record to a HipChat room. Specify the Room Notification URL, Auth Token, and Incident record to send.</td>
</tr>
<tr>
<td>Post Problem Details</td>
<td>Send details about a ServiceNow problem record to a HipChat room. Specify the Room Notification URL, Auth Token, and Problem record to send.</td>
</tr>
</tbody>
</table>

HipChat Inputs

The following inputs are common to the HipChat actions:

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Required] Room Notification URL</td>
<td>The HipChat notification REST API URL. Example: <a href="https://api.hipchat.com/v2/%5C%7Broom">https://api.hipchat.com/v2/\{room</a> name}/ah-test/notification</td>
</tr>
<tr>
<td>[Required] Auth Token</td>
<td>You need an access token to send notifications. Refer to the HipChat API access token guide for details.</td>
</tr>
<tr>
<td>[Optional] Additional Message</td>
<td>Add a message to the record details.</td>
</tr>
<tr>
<td>[Optional] Override Default Field</td>
<td>You can provide a comma-separated list of field names to send instead of the default fields. Default fields are Short Description, Category, State, Priority, and Assignment Group.</td>
</tr>
</tbody>
</table>
**Example**

You can add a HipChat Post Incident Details action to a flow which identifies high priority incidents and who they are assigned to.

![Sample Flow Diagram](image)

**Infoblox spoke v1.0.2**

Automate network management tasks in Infoblox from your ServiceNow instance. For example, register or delete IP addresses on an Infoblox server.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

**Supported version**

Infoblox versions 2.7 and 2.9.

**Spoke flows**

The Infoblox spoke provides sample flows in the draft state to automate allocating IP addresses in the Infoblox grid server. To customize a sample flow, copy it to a new application scope. Available sample flows include:
### Spoke subflows

The Infoblox spoke provides sample subflows to register and reserve IP addresses.

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Infoblox Register or Reserve IP in IPAM</td>
<td>Registers or reserves an IP address in Infoblox based on a Service Catalog item request.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register AName Record and Get Network Details</td>
<td>Registers an AName record type in the DNS server and retrieves network details such as network options and ID.</td>
</tr>
</tbody>
</table>

### Spoke actions

The Infoblox spoke provides actions to manage IP addresses and networks in Infoblox from your ServiceNow instance. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP</td>
<td>Delete IP Reservation</td>
<td>Deletes IP address range from an Infoblox server.</td>
</tr>
<tr>
<td></td>
<td>List IP Address Reservation</td>
<td>Lists IP address reservation in the DHCP server for a given Infoblox network view.</td>
</tr>
<tr>
<td></td>
<td>Reserve IP Address Range</td>
<td>Reserves an IP address range in the Infoblox server.</td>
</tr>
<tr>
<td>DNS</td>
<td>List CName Records</td>
<td>Lists CName records present in the Infoblox server.</td>
</tr>
<tr>
<td></td>
<td>List DNS Records</td>
<td>Lists DNS records present in the Infoblox server.</td>
</tr>
<tr>
<td></td>
<td>Register AName Record</td>
<td>Registers an AName record type in DNS server. An AName record stores mapping between the fully qualified domain name and the IP address.</td>
</tr>
<tr>
<td></td>
<td>Register CName Record</td>
<td>Registers a CName record in the Infoblox DNS Server. A CName record is an alias to the fully qualified domain name.</td>
</tr>
<tr>
<td></td>
<td>Delete DNS Record</td>
<td>Deletes a DNS record in the Grid Server.</td>
</tr>
<tr>
<td>IPAM</td>
<td>Delete IPAM IP Address Reservation</td>
<td>Deletes an IPAM IP address Reservation in Infoblox.</td>
</tr>
<tr>
<td></td>
<td>List all the IPAM Reservations</td>
<td>Lists the IP addresses within a given Infoblox Server.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Register IPAM IP Address</td>
<td>Registers the IP addresses within a given Infoblox Server.</td>
</tr>
<tr>
<td></td>
<td>Reserve IPAM IP Addresses</td>
<td>Reserves the IP addresses within a given Infoblox Server.</td>
</tr>
<tr>
<td>Network</td>
<td>Create Network</td>
<td>Creates a network within a given Infoblox Server.</td>
</tr>
<tr>
<td></td>
<td>Delete Network</td>
<td>Deletes a network within a given Infoblox Server.</td>
</tr>
<tr>
<td></td>
<td>Get Network Details</td>
<td>Gets the network details within a given Infoblox Server.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Credentials and connection information.

This spoke uses the Infoblox alias record to authorize actions.

<table>
<thead>
<tr>
<th>Connection &amp; Credential alias</th>
<th>Description</th>
<th>Connection alias requirements</th>
</tr>
</thead>
</table>
| Infoblox                      | Connection to Infoblox server | • Connection type: HTTP  
• Connection URL: URL of the host machine where the Infoblox server is installed. |

To use the spoke connection alias, create an associated Connection record and an associated Credential record.

**MID Server requirements**

These actions use REST calls, which must run on a MID Server. Use the connection record associated with the Infoblox alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up Infoblox spoke**

Integrate the ServiceNow instance and Infoblox using basic authentication to authenticate ServiceNow requests.

- Request IntegrationHub subscription.
- Activate the Infoblox spoke.
- Role required: admin
Create Credential records for the Infoblox spoke
Create Credential records to the Infoblox server. The Infoblox spoke connection and credential alias uses these credentials to authorize actions.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select Basic Auth Credentials.
   A blank Basic Auth Credentials form displays.
4. Enter these values.

   ! Note: The user name and password must be for a user with permissions to perform the actions associated with the spoke, usually an administrator.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Infoblox Credentials.</td>
</tr>
<tr>
<td>User name</td>
<td>Your Infoblox user name.</td>
</tr>
<tr>
<td>Password</td>
<td>Your Infoblox password.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create Connection records for the Infoblox spoke
Create Connection records to your Infoblox account. The Infoblox spoke connection and credential alias uses these connections to perform actions on the Infoblox server.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the record for Infoblox.
3. Optional: Select the Connection Attributes tab. If necessary, edit the Default value of the API. The default value of the API is associated with your Infoblox application version. For example, application version 13 uses v2.9 of the API.
   The system displays a blank HTTP(s) Connection form.
5. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Infoblox Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Infoblox. For example, select Infoblox Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>The URL of the host machine where the Infoblox server is installed.</td>
</tr>
</tbody>
</table>

6. Click Submit.
GitHub spoke

Manage distributed version control and source code in GitHub from your ServiceNow instance. Create flows in ServiceNow to manage collaborative features such as tracking bugs, feature requests, tasks and so on, for projects in GitHub.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

Supported versions

This spoke was built for GitHub API version v3, but may be compatible with later versions.

Spoke requirements

• GitHub account
• User with admin credentials
• Token to authenticate the ServiceNow instance

See the GitHub documentation for instructions on creating GitHub account and generating token.

GitHub Webhooks module

Bi-directional webhooks can be setup to be notified about the required events. Routing policy defines conditions that must be met to notify the ServiceNow app. These conditions are based on the events in GitHub for which you wish to be notified about. When the conditions are met, routing policy triggers the associated subflow, which in turn automates the GitHub tasks.

The bi-directional webhooks requires separate setup and can be used independently without using the spoke actions. By default, the GitHub Webhooks application is available in the GitHub spoke and has the following modules:

• GitHub Webhook Registries
• GitHub WebHook Routing Policies

Use the GitHub WebhookRegistries module to assign a token and provide the API path. You must generate Callback URL here and provide this URL in GitHub. A default routing policy is provided in the GitHub WebHook Routing Policies module. The default routing policy supports these GitHub fields:

<table>
<thead>
<tr>
<th>Supported GitHub fields</th>
<th>Project Card Creator</th>
<th>Ref</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Project Card Note</td>
<td></td>
</tr>
<tr>
<td>Base Ref</td>
<td>Ref Type</td>
<td></td>
</tr>
<tr>
<td>Supported GitHub fields</td>
<td>Now Platform capabilities</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>--------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Commit Comment Body</td>
<td>Project Card Previous Note</td>
<td></td>
</tr>
<tr>
<td>Commit Comment Created At</td>
<td>Project Card Updated At</td>
<td></td>
</tr>
<tr>
<td>Commit Comment Path</td>
<td>Project Column Created At</td>
<td></td>
</tr>
<tr>
<td>Commit Comment Updated At</td>
<td>Project Column Name</td>
<td></td>
</tr>
<tr>
<td>Commit Comment User</td>
<td>Project Column Previous Name</td>
<td></td>
</tr>
<tr>
<td>Force Push</td>
<td>Project Column Updated At</td>
<td></td>
</tr>
<tr>
<td>GitHub Instance URL</td>
<td>Project Created At</td>
<td></td>
</tr>
<tr>
<td>Issue Assigned To</td>
<td>Project Name</td>
<td></td>
</tr>
<tr>
<td>Issue Assignees</td>
<td>Project Previous Body</td>
<td></td>
</tr>
<tr>
<td>Issue Body</td>
<td>Project Previous Name</td>
<td></td>
</tr>
<tr>
<td>Issue Closed At</td>
<td>Project State</td>
<td></td>
</tr>
<tr>
<td>Issue Comment</td>
<td>Project Updated At</td>
<td></td>
</tr>
<tr>
<td>Issue Comment Count</td>
<td>Pull Request Assigned To</td>
<td></td>
</tr>
<tr>
<td>Issue Comment Created At</td>
<td>Pull Request Assignees</td>
<td></td>
</tr>
<tr>
<td>Issue Comment Updated At</td>
<td>Pull Request Body</td>
<td></td>
</tr>
<tr>
<td>Issue Created At</td>
<td>Pull Request Closed At</td>
<td></td>
</tr>
<tr>
<td>Issue Labeled To</td>
<td>Pull Request Comment Count</td>
<td></td>
</tr>
<tr>
<td>Issue Labels</td>
<td>Pull Request Created At</td>
<td></td>
</tr>
<tr>
<td>Issue Locked</td>
<td>Pull Request Draft</td>
<td></td>
</tr>
<tr>
<td>Issue Milestone</td>
<td>Pull Request Labeled To</td>
<td></td>
</tr>
<tr>
<td>Issue Previous Body</td>
<td>Pull Request Labels</td>
<td></td>
</tr>
<tr>
<td>Issue Previous Comment</td>
<td>Pull Request Locked</td>
<td></td>
</tr>
<tr>
<td>Issue Previous Milestone</td>
<td>Pull Request Mergeable</td>
<td></td>
</tr>
<tr>
<td>Issue Previous Title</td>
<td>Pull Request Merged</td>
<td></td>
</tr>
<tr>
<td>Issue Previously Assigned To</td>
<td>Pull Request Merged At</td>
<td></td>
</tr>
<tr>
<td>Issue Previously Labeled To</td>
<td>Pull Request Milestone</td>
<td></td>
</tr>
<tr>
<td>Issue State</td>
<td>Pull Request Previous Body</td>
<td></td>
</tr>
<tr>
<td>Issue Title</td>
<td>Pull Request Previous Title</td>
<td></td>
</tr>
<tr>
<td>Issue Updated At</td>
<td>Pull Request Previously Assigned To</td>
<td></td>
</tr>
<tr>
<td>Issue User</td>
<td>Pull Request Previously Labeled To</td>
<td></td>
</tr>
<tr>
<td>Force Push</td>
<td>Project Column Updated At</td>
<td></td>
</tr>
<tr>
<td>GitHub Instance URL</td>
<td>Project Created At</td>
<td></td>
</tr>
<tr>
<td>Issue Assigned To</td>
<td>Project Name</td>
<td></td>
</tr>
<tr>
<td>Issue Assignees</td>
<td>Project Previous Body</td>
<td></td>
</tr>
<tr>
<td>Issue Body</td>
<td>Project Previous Name</td>
<td></td>
</tr>
<tr>
<td>Issue Closed At</td>
<td>Project State</td>
<td></td>
</tr>
<tr>
<td>Issue Comment</td>
<td>Project Updated At</td>
<td></td>
</tr>
<tr>
<td>Issue Comment Count</td>
<td>Pull Request Assigned To</td>
<td></td>
</tr>
<tr>
<td>Issue Comment Created At</td>
<td>Pull Request Assignees</td>
<td></td>
</tr>
<tr>
<td>Issue Comment Updated At</td>
<td>Pull Request Body</td>
<td></td>
</tr>
<tr>
<td>Issue Created At</td>
<td>Pull Request Closed At</td>
<td></td>
</tr>
<tr>
<td>Issue Labeled To</td>
<td>Pull Request Comment Count</td>
<td></td>
</tr>
<tr>
<td>Issue Labels</td>
<td>Pull Request Created At</td>
<td></td>
</tr>
<tr>
<td>Issue Locked</td>
<td>Pull Request Draft</td>
<td></td>
</tr>
<tr>
<td>Issue Milestone</td>
<td>Pull Request Labeled To</td>
<td></td>
</tr>
<tr>
<td>Issue Previous Body</td>
<td>Pull Request Labels</td>
<td></td>
</tr>
<tr>
<td>Issue Previous Comment</td>
<td>Pull Request Locked</td>
<td></td>
</tr>
<tr>
<td>Issue Previous Milestone</td>
<td>Pull Request Mergeable</td>
<td></td>
</tr>
<tr>
<td>Issue Previous Title</td>
<td>Pull Request Merged</td>
<td></td>
</tr>
<tr>
<td>Issue Previously Assigned To</td>
<td>Pull Request Merged At</td>
<td></td>
</tr>
<tr>
<td>Issue Previously Labeled To</td>
<td>Pull Request Milestone</td>
<td></td>
</tr>
<tr>
<td>Issue State</td>
<td>Pull Request Previous Body</td>
<td></td>
</tr>
<tr>
<td>Issue Title</td>
<td>Pull Request Previous Title</td>
<td></td>
</tr>
<tr>
<td>Issue Updated At</td>
<td>Pull Request Previously Assigned To</td>
<td></td>
</tr>
<tr>
<td>Issue User</td>
<td>Pull Request Previously Labeled To</td>
<td></td>
</tr>
</tbody>
</table>
### Supported GitHub fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Supported GitHub Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Milestone Closed At</td>
<td>Pull Request Rebaseable</td>
<td>Security Advisory Published At</td>
</tr>
<tr>
<td>Milestone Created At</td>
<td>Pull Request Review Body</td>
<td>Security Advisory Severity</td>
</tr>
<tr>
<td>Milestone Creator</td>
<td>Pull Request Review Comment</td>
<td>Security Advisory Summary</td>
</tr>
<tr>
<td>Milestone Description</td>
<td>Pull Request Review Comment Count</td>
<td>Security Advisory Updated At</td>
</tr>
<tr>
<td>Milestone Due On</td>
<td>Pull Request Review Comment Created At</td>
<td>Security Advisory Withdrawn At</td>
</tr>
<tr>
<td>Milestone State</td>
<td>Pull Request Review Comment File Path</td>
<td>Sender Login</td>
</tr>
<tr>
<td>Milestone Title</td>
<td>Pull Request Review Comment Previous Comment</td>
<td>Status Commit Message</td>
</tr>
<tr>
<td>Milestone Updated At</td>
<td>Pull Request Review Comment Updated At</td>
<td>Status Context</td>
</tr>
<tr>
<td>Organization Description</td>
<td>Pull Request Review Previous Body</td>
<td>Status Created At</td>
</tr>
<tr>
<td>Organization Login</td>
<td>Pull Request Review State</td>
<td>Status Description</td>
</tr>
<tr>
<td>Pre-Release</td>
<td>Pull Request State</td>
<td>Status Name</td>
</tr>
<tr>
<td>Project Body</td>
<td>Pull Request Title</td>
<td>Status State</td>
</tr>
<tr>
<td>Project Card Archived</td>
<td>Pull Request Updated At</td>
<td>Status Updated At</td>
</tr>
<tr>
<td>Project Card Created At</td>
<td>Pull Request User</td>
<td>Webhook Event</td>
</tr>
</tbody>
</table>

To use other conditions in the routing policy, create routing policy in the GitHub WebHook Routing Policies module and specify conditions as per your requirement. See [Set up bi-directional webhook for the GitHub spoke](#) for information regarding setting up and configuring the webhooks.

### Spoke subflow

The GitHub spoke provides a sample subflow to handle various GitHub webhook events. Available sample subflows are:

#### Spoke subflows

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
<th>Supported GitHub Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process GitHub Branch and Tag Webhook Events</td>
<td>Handles branch and tag webhook events.</td>
<td>Branch and Tag</td>
</tr>
<tr>
<td>Process GitHub Commit Webhook Events</td>
<td>Handles commit webhook events.</td>
<td>Commit</td>
</tr>
<tr>
<td>Process GitHub Issue Webhook Events</td>
<td>Handles issue webhook events.</td>
<td>Issue</td>
</tr>
<tr>
<td>Process GitHub Milestone Webhook Events</td>
<td>Handles milestone webhook events.</td>
<td>Milestone</td>
</tr>
</tbody>
</table>
### Subflows

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
<th>Supported GitHub Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process GitHub Project Webhook Events</td>
<td>Handles project webhook events.</td>
<td>Project</td>
</tr>
<tr>
<td>Process GitHub Pull Request Webhook Events</td>
<td>Handles pull request webhook events.</td>
<td>Pull Request</td>
</tr>
<tr>
<td>Process GitHub Push Webhook Events</td>
<td>Handles push request webhook events.</td>
<td>Push Request</td>
</tr>
<tr>
<td>Process GitHub Release Webhook Events</td>
<td>Handles release webhook events.</td>
<td>Release</td>
</tr>
<tr>
<td>Process GitHub Repository Webhook Events</td>
<td>Handles repository webhook events.</td>
<td>Repository</td>
</tr>
<tr>
<td>Process GitHub Security Webhook Events</td>
<td>Handles security webhook events.</td>
<td>Security</td>
</tr>
<tr>
<td>Process GitHub Webhook Events</td>
<td>Handles all GitHub webhook events.</td>
<td>Note: This subflow handles all GitHub events. You can customize this subflow to handle other GitHub webhook events that are not supported by default.</td>
</tr>
</tbody>
</table>

To create subflows to handle other GitHub webhook events or handle the supported GitHub webhook events differently, customize the Process GitHub Webhook Events subflow. For this, you must create a copy of the subflow, parse the payload, and customize the subflow as per your requirement. Payload is one of the inputs to the subflow.

While customizing subflows, you must ensure that the subflows are configured to avoid infinite loops.

**Note:**
- You must configure webhooks to use the spoke subflow. See Set up bi-directional webhook for the GitHub spoke for information regarding setting up and configuring the webhook.
- The sample subflows run as a user by default. It can be configured to run as system.
- GitHub spoke supports application/json payload. Configure the GitHub webhook accordingly. See the GitHub Developer documentation for instructions on creating and configuring a webhook.

### Spoke actions

The GitHub spoke provides actions to manage branches, issues, repositories, and source code when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Branch Management</td>
<td>Create Branch</td>
<td>Creates a branch in GitHub based on a specific commit SHA.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delete Branch</td>
<td>Deletes a branch from the GitHub repository.</td>
</tr>
<tr>
<td></td>
<td>Get Branch</td>
<td>Retrieves the details of a branch in the GitHub repository.</td>
</tr>
<tr>
<td></td>
<td>Get Branch Protection</td>
<td>Retrieves the restriction details of the required branch.</td>
</tr>
<tr>
<td></td>
<td>List Branch</td>
<td>Retrieves the list of all branches in a repository.</td>
</tr>
<tr>
<td></td>
<td>Remove Branch Protection</td>
<td>Removes protection on the required branch.</td>
</tr>
<tr>
<td></td>
<td>Update Branch Protection</td>
<td>Updates protection on the required branch.</td>
</tr>
<tr>
<td>Issue Management</td>
<td>Create Comment on Issue</td>
<td>Creates comment on a required issue.</td>
</tr>
<tr>
<td></td>
<td>Create Issue</td>
<td>Creates issue for the required repository.</td>
</tr>
<tr>
<td></td>
<td>Delete Comment on Issue</td>
<td>Deletes comment on a required issue.</td>
</tr>
<tr>
<td></td>
<td>Lock Issue</td>
<td>Locks the required issue. This limits the conversation to collaborators only.</td>
</tr>
<tr>
<td></td>
<td>Look Up Comments on Issue</td>
<td>Retrieves the list of comments on an issue.</td>
</tr>
<tr>
<td></td>
<td>Look Up Issues</td>
<td>Retrieves the list of issues for a repository.</td>
</tr>
<tr>
<td></td>
<td>Unlock Issue</td>
<td>Unlocks the required issue. This opens conversation to all users.</td>
</tr>
<tr>
<td></td>
<td>Update Comment on Issue</td>
<td>Updates a comment on an issue.</td>
</tr>
<tr>
<td></td>
<td>Update Issue</td>
<td>Updates the details of the required issue.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Fields by Action</td>
<td>Retrieves the list of fields for an action filter in the GitHub Fields table.</td>
</tr>
<tr>
<td>Repository Management</td>
<td>Add Collaborator</td>
<td>Adds collaborator to the required repository.</td>
</tr>
<tr>
<td></td>
<td>Create Comment on Pull Request</td>
<td>Create review comments on a pull request.</td>
</tr>
<tr>
<td></td>
<td>Create Milestone</td>
<td>Creates milestone for the required repository.</td>
</tr>
<tr>
<td></td>
<td>Create Pull Request</td>
<td>Creates a pull request for a repository.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Create Reply on Pull Request Review Comment</td>
<td>Creates reply to a review comment for a pull request.</td>
</tr>
<tr>
<td></td>
<td>Create Repository</td>
<td>Creates a repository in GitHub.</td>
</tr>
<tr>
<td></td>
<td>Delete Comment on Pull Request</td>
<td>Deletes review comment on a pull request.</td>
</tr>
<tr>
<td></td>
<td>Delete Milestone</td>
<td>Deletes milestone from the required repository.</td>
</tr>
<tr>
<td></td>
<td>List Comments on Pull Request</td>
<td>Retrieves the list of all review comments on a pull request.</td>
</tr>
<tr>
<td></td>
<td>List Milestones</td>
<td>Retrieves the list of all milestones in a repository.</td>
</tr>
<tr>
<td></td>
<td>Look Up Pull Requests</td>
<td>Retrieves the details of pull requests for a repository.</td>
</tr>
<tr>
<td></td>
<td>Look Up Repositories</td>
<td>Retrieves the details of repositories based on a specific user or organization.</td>
</tr>
<tr>
<td></td>
<td>Merge Pull Request</td>
<td>Merges the pull request to a repository.</td>
</tr>
<tr>
<td></td>
<td>Remove Collaborator</td>
<td>Removes collaborator from a repository.</td>
</tr>
<tr>
<td></td>
<td>Update Comment on Pull Request</td>
<td>Updates review comment provided for a pull request.</td>
</tr>
<tr>
<td></td>
<td>Update Milestone</td>
<td>Updates the details of a milestone in a repository.</td>
</tr>
<tr>
<td></td>
<td>Update Pull Request</td>
<td>Updates the details of a pull request in a repository.</td>
</tr>
<tr>
<td></td>
<td>Update Repository</td>
<td>Updates the details of a repository in GitHub.</td>
</tr>
<tr>
<td>Source Code Management</td>
<td>Create Comment on Commit</td>
<td>Creates comment for the required commit using its SHA.</td>
</tr>
<tr>
<td></td>
<td>Create or update a file</td>
<td>Creates a file or updates an existing file in a repository.</td>
</tr>
<tr>
<td></td>
<td>Get Comments By Commit ID</td>
<td>Retrieves comments provided for a single commit.</td>
</tr>
<tr>
<td></td>
<td>Get Commit Information By ID</td>
<td>Retrieves the contents of the required commit reference.</td>
</tr>
<tr>
<td></td>
<td>Get File Content</td>
<td>Retrieves the contents of a file in a repository.</td>
</tr>
</tbody>
</table>

**Note:** This action supports files with file size up to 1 MB.
### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see [Credentials and connection information](#).

### Set up GitHub spoke

Integrate the ServiceNow instance and GitHub account using an API key to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Activate GitHub spoke
- Generate token and record the value
- Role required: admin

*Create Credential record for the GitHub spoke*

Create Credential records for the GitHub spoke. The GitHub spoke connection and credential aliases use these credentials to authorize actions.

Role required: admin

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   The system displays the message *What type of Credentials would you like to create?*.
3. Select **API Key Credentials**.
   A blank API Key Credentials form displays.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter <em>GitHub Credentials</em>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>API Key</td>
<td>Token generated in GitHub. See the <a href="#">GitHub documentation</a> for instructions on creating GitHub account and generating token.</td>
</tr>
<tr>
<td>Applies to</td>
<td><strong>Note</strong>: This option is not applicable to this spoke.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
Create Connection records for the GitHub spoke

Create Connection records for your GitHub account. The GitHub spoke connection and credential aliases use these connections to perform actions in GitHub.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for GitHub.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter GitHub Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for GitHub. For example, select GitHub Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL. Enter <a href="https://api.github.com/">https://api.github.com/</a>.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Set up bi-directional webhook for the GitHub spoke

Configure webhook to subscribe to GitHub with a ServiceNow callback URL.

- Request IntegrationHub subscription
- Activate the GitHub spoke
- Role required: admin

Create secret for the GitHub spoke

Create secret to embedded in the GitHub webhook URL.

Role required: admin

1. Navigate to System Definition > Scripts - Background.
2. Enter this command in the Run script (JavaScript executed on server) text field:
   
   ```javascript
   gs.info(GlideSecureRandomUtil.getSecureRandomString(16));
   ```
3. Click Run Script.
4. Copy and record the generated secret for later use.

Register GitHub webhook in ServiceNow

Register a GitHub in ServiceNow to notify the ServiceNow app when certain events occur in GitHub.

Role required: admin

1. Navigate to GitHub Webhooks > GitHub Webhook Registries.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name to identify the record. For example, GitHub webhook.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Secret</td>
<td>Secret you had generated using the Scripts - Background module.</td>
</tr>
<tr>
<td>Path</td>
<td>GitHub webhook path. By default, this is set to api/sn_github_spoke/github_webhook_callbacks/wh_entry.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.

5. Click **Callback URL**. The system displays the Webhook Callback URL.

6. Copy and record the Webhook Callback URL.

The GitHub webhook is registered in your ServiceNow instance.

**Add Callback URL in GitHub**

Provide Webhook Callback URL in GitHub account to create webhook.

**Role required:** admin

1. Log in to your GitHub account.
2. Create a webhook in your Atlassian account.
3. Enter Webhook Callback URL in **Payload URL** and Secret in **Secret**. See the GitHub Developer documentation for instructions on creating and configuring a webhook.

**Note:** GitHub spoke supports application/json payload. Configure the GitHub webhook accordingly. See the GitHub Developer documentation for instructions on creating and configuring a webhook.

The Callback URL is added in the GitHub account. You can create routing policies and subflows as per your requirement. See **Customize bi-directional webhook in the Jira spoke** for information regarding creating new routing policies and subflows.

**Customize bi-directional webhook in the GitHub spoke**

Create webhook routing policy and subflow as per your requirement in the GitHub spoke.

**Role required:** admin

The default routing policy in the GitHub WebHook Routing Policies modules triggers the relevant GitHub subflow and notifies the ServiceNow app when certain events occur in GitHub. See **GitHub spoke** for information about the GitHub fields that the default routing policy supports and the GitHub events that the subflows support. To use any other fields in your custom subflow and customize conditions in the routing policy, perform these steps.

1. Navigate to **Flow Designer > Designer**.
2. Click **Subflows**.
3. Create a copy of the required subflow.
4. Customize the required subflow as per your requirement and publish it. See **Subflows** for more information about creating and using subflows and GitHub spoke for information about the GitHub fields that the default routing policy supports and the GitHub events that the subflows support.

5. Navigate to **GitHub Webhooks > GitHub WebHook Routing Policies**.
6. Click **New**.
7. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique label to identify the routing policy.</td>
</tr>
<tr>
<td>Default answer</td>
<td>Option to specify if this is the default answer. Default answer is applicable when the conditions are not met.</td>
</tr>
<tr>
<td></td>
<td>a. Click the Lookup icon.</td>
</tr>
<tr>
<td></td>
<td>b. Select the required subflow from the Document list.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions to be met when the required events occur in GitHub. See GitHub spoke for information about the supported fields.</td>
</tr>
<tr>
<td>Answer</td>
<td>Subflow that has to be triggered when the specified conditions are met.</td>
</tr>
</tbody>
</table>

8. Click **Submit**.

**Note:** These routing policies are saved in the Decision tables. Users are cautioned against directly updating or modifying data in these tables.

Routing policy and subflow are created.

**Google Cloud Translator Service Spoke**

Provides subflows and actions to dynamically translate the user-entered text, and to detect the language of the text using Google’s translation services.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**Subscription**

This spoke requires one of the following subscriptions:

- Any ServiceNow subscription that is Professional or above, and includes Dynamic Translation.
- IntegrationHub Professional subscription package. For more information see, Request IntegrationHub.
Supported versions

Google Translate API version v3

Scope of the spoke in the Dynamic Translation framework

To use Google Cloud Translator Service Spoke in the Dynamic Translation framework, ensure that the spoke is installed in ServiceNow Store and the Dynamic Translation plugin is active. For more information, see #unique_1112.

Spoke flows

This spoke has no sample flows.

Spoke subflows

The Google Cloud Translator Service Spoke provides subflows in the Published state to integrate with Google’s translation services. These subflows can be used as part of other subflows and flows.

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detect Language</td>
<td>Contains a set of inputs, actions, and outputs to detect the language of the</td>
</tr>
<tr>
<td></td>
<td>input text.</td>
</tr>
<tr>
<td>Translate Text To Multiple Languages</td>
<td>Contains a set of inputs, actions, and outputs to translate the input text</td>
</tr>
<tr>
<td></td>
<td>to multiple languages.</td>
</tr>
</tbody>
</table>

Spoke actions

The Google Cloud Translator Service Spoke provides actions to integrate with the Google translation service. Available actions include:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detect Language</td>
<td>Detects the language of the input text.</td>
</tr>
<tr>
<td>Translate Text To Single Language</td>
<td>Translates the input text to a single language.</td>
</tr>
<tr>
<td>Translate Text To Multiple Languages</td>
<td>Translates the input text to multiple languages.</td>
</tr>
</tbody>
</table>

Google account requirements

The Google Cloud Translator Service Spoke requires configuring your Google Cloud account to generate an OAuth 2.0 JWT Bearer Grant token.

Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple
environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Credentials and connection information.

This spoke uses the GoogleTranslation alias record (sn_google_trans.GoogleTranslation) to authorize actions.

Set up Google Cloud Translator Service Spoke

Integrate your Google account with your ServiceNow instance.

• Role required: admin
  • Create a service account on Google Cloud, generate a service account key of JSON type and download it. For information on creating the service account key, see the Google documentation.
  • Enable the Cloud Translation API service. For information on enabling a service, see the Google documentation.

Create a Java KeyStore certificate

Encrypt the security certificates obtained from Google by creating a Java KeyStore (JKS) file.

• Role required: admin
  • Download a JSON file containing the service account key from Google. For information on downloading the JSON file, see the Google documentation. Following is a sample JSON file:

```json
{
  "type": "service_account",
  "project_id": "primeval-nectar-242610",
  "private_key_id": "0c6c7b151f1c236c1300c5933d528bbf45314e5",
  "private_key": "BEGIN PRIVATE KEY-----

MIIEvQIKADANBgkqhkiG9w0BAQEFAASCBKgwjSAGEAoIBAQDg97zoOensoyu2\niXc8ArQHaAgOiy27s+
+qILHzkIbZY1Zx+CmjNFpUPzheRkpW\n5Q02bjHCqCTVFtcBoKixH

VkMsP7L0+TKFW2TkIHZxW0zXv30b+2hkS4tZtisMy\n
s16dgJaokd4yTIBwZc7v1r88GJd9w45+9NVxEpM/G8drYJRlImyfmd0RGR

nyptkheart3Wzr/CESb/VH5K5KspRt/xQvWzSs5pW7a8NdrB1z+yQ1gG0UlfINXE

QzE5GhiUF+xScfgdq30cuFO1LO9xAK/41yqB8z1r4rU5H10F01jp4t6flw3k2o


NoDrsr++R*XAgMBAAECgAAg6QJy9Jswr6mEE+Yf7u8LW9kbSf0wZwMf0UIpE

np5eBOEtEomedmuN/KmdMqsn8Oux3GkIUDuWUNs905wVPSVus8S0v7J5zyv


EvAvAUxX/1gMTeVPf34tRca3QX0SMyq2q+pu3uyKNSrshBN0T1xXAE6xU0G81auoL

Y17p7pVcx6W050V51AuMc8+0rgadvOpU3JThjauMeVvNDF1K15abKDSncFQtQyD


HMMny+uhfCor2JtTgpc4Uhgq0kPAALAvQRYym1qkFmgNo+xo+DBBKJsdp7D9NnxQn

M718wqQ0kS2kfcJHHCv4ZUORabzl1MP1vdxxiejYkBqQ5d7J/MgN4LLeikaime

3t27KTA12alkQ1LORQLBHHzRexVD10lwrQyS7ZUVQXiSwzW9ROLO

hptDrNyUh/n6WQVlswSLvlnvE+8akZ2mb3F/NDEPb/

R1FpdTR30G7WxXeau1+cm8+8N63ehFAW4/n7IXYDntO5c3deXN7SDRFjrNQBqQDMqAdRkkPwau6q
+zSGPmGf3QxS+ghpQkT/nUPxe45a2dRufU0UCWA9BIBm1VHEU5qpi1bf3J9Tc2s

VbWltQzj1ZbPnlmKt+7QF4t5edar826v0N1rweupAmFLQqN7GoopUD

+Rr068BSKIPcZgLtu3PzLEmgj/nRyz55HUTwKkgz05zscTjBmn9yapiyNMX7UDX/

FJhmeEC04l0t4sEHuFas3Y6+nNhUFRf7QsG

+03uA4JQFP8tbICU58x8gbNmCLYXHvGWx0MB2Wx0HvFsh8yRsa


0ubWbsDmCvgPysj0p+x5+cHdgfYnUaDn3nzn7Y/Y1Su1hY4E2/pEJUJoAGAdUg1


MmEStkD253d24wn77kmAPlMxk7yDqLkV5Hjegg/ezskKOY049UXIjFjze2SP2


/n8nnrzk4m3IqNgd4cGanAqSgg9C878FSvfmavyczca6d3XN5wQ4E+bf/4ot2RRT

HvYRqQvzZ2B8XmyYzZxcCw+tP坦克9eLd4D4V79D8CgyAeAEywni15b50lksW9yp


/n0u5eJekMNvmYmdp5lyw1PoyN9nx/3Yy3m2F77d2K7aBpKUXLZqv5tbcF2vfdO


/nbme4EIsLqg8kzd09OohAserzUGizIw4tVQyWRL4xrdOY99GkhB8N44tU7uN\nPcSwW/rdB8DThqerToF80lU=\n
\n
"client_email": "service-now-google-trans-v3@primeval-nectar-242610.iam.serviceaccount.com",
"client_id": "113255944370425109391",
"auth_url": "https://accounts.google.com/o/oauth2/auth",
"token_url": "https://oauth2.googleapis.com/token",
"auth_provider_x509_cert_url": "https://www.googleapis.com/oauth2/v1/certs",
"cred_...
1. In the JSON file, perform the following for the `private_key` value.
   a) Unescape the `\n` characters.
   b) Store the private key in a file with .pem extension.

2. In the JSON file, perform the following for the `client_x509_cert_url` value.
   a) Open the link specified for `client_x509_cert_url`.
   b) Unescape the `\n` characters for the certificate associated with the `private_key_id` mentioned in the JSON file.
   c) Store the certificate value in a file with .pem extension.

3. Use the `openssl` command to create a PKCS 12 file using the recently created private key and certificate files.
   ```
   ```
   For example, if certificate.pem is the certificate and privatekey.pem is the private key:
   ```
   openssl pkcs12 -export -in certificate.pem -inkey privatekey.pem -certfile certificate.pem -out testkeystore.p12
   ```
   A PKCS 12 file, testkeystore.p12, is created.

4. Specify an export password or source keystore password.
   **Note:** You should specify this password when creating a JWT key for Google Cloud Translator Service Spoke.

5. Use the `keytool` command to create a JKS file from the PKCS 12 file.
   ```
   keytool -importkeystore -srckeystore testkeystore.p12 -srcstoretype pkcs12 -destkeystore wso2carbon.jks -deststoretype JKS
   ```
   **Note:** testKeyStore.p12 is the PKCS 12 file and wso2carbon.jks is the JKS file.

6. Specify a destination keystore password.
   **Note:** You should specify this password when attaching a JKS certificate to Google Cloud Translator Service Spoke.

Attach a Java KeyStore certificate to Google Cloud Translator Service Spoke
Enable the JWT client authentication by attaching a valid Java KeyStore (JKS) certificate to Google Cloud Translator Service Spoke.

- Role required: admin
- Valid Java KeyStore certificate

1. Navigate to **System Definition > Certificates**.
2. Click **New**.
3. On the form, fill in the fields.

### X.509 Certificate form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Identifier of the certificate.</td>
</tr>
<tr>
<td>Notify on expiration</td>
<td>Users to be notified when the certificate expires.</td>
</tr>
<tr>
<td>Warn in days to expire</td>
<td>Number of days to send a notification before the certificate expires.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the certificate.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the certificate. Select <strong>Java Key Store</strong>.</td>
</tr>
<tr>
<td>Expires in days</td>
<td>Number of days until the certificate expires.</td>
</tr>
<tr>
<td>Key store password</td>
<td>Password to access the certificate. Use the destination keystore password</td>
</tr>
<tr>
<td></td>
<td>specified when creating the JKS certificate. For more information on this</td>
</tr>
<tr>
<td></td>
<td>password, see Create a Java KeyStore certificate.</td>
</tr>
<tr>
<td>Short description</td>
<td>Summary about the certificate.</td>
</tr>
</tbody>
</table>

4. Click the manage attachments icon ( ) and attach a JKS certificate.
5. To validate the JKS certificate, click **Validate Stores/Certificates**.
6. Click **Submit**.

*Create a JWT signing key for Google Cloud Translator Service Spoke*

Assign a JSON Web Token (JWT) signing key to your Java KeyStore certificate.

Role required: admin

1. Navigate to **System OAuth > JWT Keys**.
2. Click **New**.
3. On the form, fill in the fields.

### JWT Keys form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Identifier of the JWT signing key.</td>
</tr>
<tr>
<td>Signing Keystore</td>
<td>Valid JKS certificate for which you want to assign the key.</td>
</tr>
<tr>
<td>Key Id</td>
<td>Key ID to identify which key is used when multiple keys are used to sign tokens.</td>
</tr>
<tr>
<td>Signing Algorithm</td>
<td>Algorithm to sign with the key.</td>
</tr>
<tr>
<td>Signing Key Password</td>
<td>Password associated with the key. Use the export password or the source keystore password specified when creating the JKS certificate. For more information on this password, see Create a Java KeyStore certificate.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the key.</td>
</tr>
</tbody>
</table>
4. Click **Submit**.

*Create a JWT provider for Google Cloud Translator Service Spoke*

Add a JSON Web Token (JWT) provider to Google Cloud Translator Service Spoke.

Role required: admin

1. Navigate to **System OAuth > JWT Providers**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Identifier of the JWT provider.</td>
</tr>
<tr>
<td>Expiry Interval (sec)</td>
<td>Number of seconds that indicate the lifespan of the JWT provider token. Specify 3600.</td>
</tr>
<tr>
<td>Signing Configuration</td>
<td>JWT signing key.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.
5. In the Standard Claims related list, enter the values for these claims.

<table>
<thead>
<tr>
<th>Claim name</th>
<th>Claim value</th>
</tr>
</thead>
<tbody>
<tr>
<td>aud</td>
<td><a href="https://www.googleapis.com/oauth2/v4/token">https://www.googleapis.com/oauth2/v4/token</a></td>
</tr>
<tr>
<td>iss</td>
<td>client_email value from the JSON file.</td>
</tr>
</tbody>
</table>

6. In the Custom Claims related list, create the **scope** claim and enter its value as https://www.googleapis.com/auth/cloud-translation.
7. Click **Update**.

*Configure the credential for the GoogleTranslation alias*

Authorize actions of Google Cloud Translator Service Spoke by configuring the Google OAuth 2.0 credential.

Role required: admin

1. Navigate to **Connections & Credentials > Credentials**.
2. Select the Google OAuth 2.0 credential.
3. Open the record specified in the **OAuth Entity Profile** field.
4. In the **JWT Provider** field, specify the JWT provider that you want to use.
5. Click **Update**.
6. To verify if an OAuth Access token is generated to connect to Google’s translation services, click the **Get OAuth Token** related link of the Google OAuth 2.0 credential.

*Configure the connection attributes for the GoogleTranslation alias*

Connect to the Google’s translation service by configuring the Google connection. Provide information that is used by HTTP(s) actions or activities to connect to that service.

Role required: connection_admin

1. Navigate to **Connections & Credentials > Connections**.
2. Open for the record for **Google**.
3. In the Attributes related list of the HTTP(S) Connection form, fill in the fields.

### HTTP(S) Connection form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>location</td>
<td>Location of the customer. If the value is not specified when creating an account on Google Cloud, then specify global.</td>
</tr>
<tr>
<td>project_id</td>
<td>Identifier of a project. Specify the project_id value from the JSON file.</td>
</tr>
<tr>
<td>version</td>
<td>API version that the related spokes are built for. The default value is v3beta1. Because Google now supports the v3 version, you can override this value as v3.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.

### Google Drive spoke v1.2

Use Google Drive as file storage in place of attachments in ServiceNow. Adds Google Drive storage to your ServiceNow instance and enables users to reference Google Drive files in ServiceNow records.

### Request apps on the Store

Visit the [ServiceNow Store](https://store.service-now.com) website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the [ServiceNow Store version history release notes](https://store.service-now.com).

### IntegrationHub subscription

This spoke requires the IntegrationHub Professional subscription package. For more information, see [Request IntegrationHub](https://store.service-now.com).

### Supported versions

API version v1.

### Spoke subflows

The Google Drive spoke provides sample subflows in the draft state to demonstrate automating Google Drive tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move a ServiceNow attachment to Google Drive</td>
<td>Copies an attachment from ServiceNow to Google Drive, records the new location of the attachment, and deletes the attachment from the ServiceNow attachment table.</td>
</tr>
</tbody>
</table>
Spoke actions

The Google Drive spoke provides actions to perform Google Drive tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File and Folder Management</td>
<td>Copy Attachment to Drive</td>
<td>Copies a ServiceNow attachment to a Google Drive folder. It either copies to the root drive of the current account or to the specified folder. To change the file name during the copy, use the optional file name.</td>
</tr>
<tr>
<td></td>
<td>Copy Doc File To Attachment</td>
<td>Copies a file Google Drive and attaches it to a ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Copy Drive File</td>
<td>Creates a copy of a Google Drive File and applies any metadata updates like a change in file name, file description, parent folder location, if file is starred, or shared by users with writer permissions.</td>
</tr>
<tr>
<td></td>
<td>Copy Drive File To Attachment</td>
<td>Copies a drive file to a ServiceNow attachment. If a ServiceNow record is supplied as input, the record should be attached to it.</td>
</tr>
<tr>
<td></td>
<td>Create Folder</td>
<td>Creates a Google Drive folder that can be nested within other folders.</td>
</tr>
</tbody>
</table>
|                                  | Delete Drive File Or Folder         | Permanently deletes a drive file or folder owned by the Google Drive account user without moving it to the trash. To delete folders the user must be the owner of folder and its contents.
<p>|                                  | Look Up Folders                    | Returns a list of Google Drive folder IDs based on given search parameters. |
|                                  | Update Attachment To Drive         | Updates the contents of a file, but maintains the previous versions and metadata. This action only updates the content of the Google Drive file. It does not update metadata. |
|                                  | Update File Or Folder Metadata     | Updates the metadata on a file or folder. This can be a file name change, change to the file description, a move to a new parent folder, a change in starred status, or a change to sharing permissions. |</p>
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permission Management</td>
<td>Create File or Folder Permission</td>
<td>Adds a permission to a given user, group, domain, or anyone for a file or folder. If User or Group is selected, the email address is required for those users and groups. If Domain is selected, the domain name is required. If Anyone is selected, then anyone has permissions to the file or folder.</td>
</tr>
<tr>
<td></td>
<td>Delete File Or Folder Permission</td>
<td>Removes a permission to a given user, group, domain, or anyone for a file or folder.</td>
</tr>
<tr>
<td></td>
<td>Look Up File Or Folder Permissions By ID</td>
<td>Returns the list of permissions associated with a particular file or folder.</td>
</tr>
<tr>
<td></td>
<td>Transfer Ownership Of All User Data</td>
<td>Transfers the ownership of data from one user to another within a domain. All previous permissions of old owner are removed and new owner permissions are created for new user.</td>
</tr>
<tr>
<td></td>
<td>Update File Or Folder Permission</td>
<td>Updates a given permission by updating the role.</td>
</tr>
</tbody>
</table>

**Google Drive Online account requirements**

The Google Drive spoke requires a custom app that you create in Google Drive Enterprise or Google G Suite.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see [Credentials and connection information](#).

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Google Drive alias to configure where actions run as well as set MID Server selection attributes. For more information, see [MID server](#).

**Set up Google Drive spoke**

Integrate a ServiceNow instance and Google Drive spoke by using G Suite credentials to authenticate ServiceNow requests.

- Install the Google Drive spoke.
- Request IntegrationHub subscription.
• Activate the Google Drive spoke.
• Role required: admin

**Configure Google Drive application**
Create a custom OAuth application from your Google Drive account to enable OAuth 2.0 authentication with the Google Drive spoke.

Google Drive integration requirements:
• A domain and an email address associated with the domain. For example, www.mydomain.com and jane-admin@mydomain.com. Note that you can only register one email address per domain in GSuite or Google Drive.
• A Google G Suite or Google Drive login created with the domain.
• A Google Drive account.

Complete these steps from your Google G Suite or Google Drive account. See the G Suite product documentation for instructions on creating and configuring custom applications.

2. Enter your business name, the number of employees, and your country, and click **Next**.
3. Enter the administrator contact name, email address and business phone number, and click **Next**.
4. Enter the domain associated with this spoke.
5. Provide the user name and password for your domain.
6. Add users to the G Suite account.
7. Verify your domain and email address.
   Users must create their own logins by navigating to the Google documentation.
9. Search for the Google Drive API and enable it.
10. Create a Credentials application and save the Client ID and Client secret.
   The Client Secret is only displayed in plain text for a short time. Copy the Client ID and the Client Secret to a text file so that you can use them when you Register Google Drive as an OAuth provider.

**Register Google Drive as an OAuth provider**
Use the information generated during Google Drive account configuration to register the Google Drive application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

• Request IntegrationHub subscription.
• Activate Google Drive spoke.
• Create Google Drive application.

Role required: admin

1. In ServiceNow, navigate to **System OAuth > Application Registry**.
2. Click **New**.
3. On the screen titled **What kind of OAuth application**, select **Connect to a third-party OAuth Provider**.
4. Enter these values in the Application Registries form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record, for example GoogleDrive.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the Client ID of the Google Drive application you created in G Suite.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret you generated when you created the application in G Suite.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Click the search icon and select OAuthUtilGoogleDrive.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select <strong>Authorization Code</strong>.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>Click the lock icon, enter <a href="https://accounts.google.com/o/oauth2/auth">https://accounts.google.com/o/oauth2/auth</a>, and then click the lock icon again.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Click the lock icon, enter <a href="https://www.googleapis.com/oauth2/v4/token">https://www.googleapis.com/oauth2/v4/token</a>, and then click the lock icon again.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>Click the lock icon, enter https://&lt;instance&gt;.service-now.com/oauth_redirect.do, and then click the lock icon again.</td>
</tr>
</tbody>
</table>
5. Optional: In the **OAuth Entity Scopes** related list, add any scopes required by your application. The Google Drive spoke includes these scopes by default:

- appdata
- drive
- drivereadonly
- file
- filetransfer
- metadata
- metadatereadonly
- photosreadonly
- scripts
- user
Click **Insert a new row** and enter the name and the OAuth scope of the permission. The name and the OAuth scope are often the same.

<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendars.ReadWrite</td>
<td>Calendars.ReadWrite</td>
</tr>
<tr>
<td>Calendars.ReadWrite.Shared</td>
<td>Calendars.ReadWrite.Shared</td>
</tr>
<tr>
<td>email</td>
<td>email</td>
</tr>
<tr>
<td>Files.Read</td>
<td>Files.Read</td>
</tr>
<tr>
<td>Files.Read.All</td>
<td>Files.Read.All</td>
</tr>
</tbody>
</table>

6. Right-click the form header, and click **Save**. The system validates the OAuth credentials.

**Create Credential record for the Google Drive spoke.**

Create **Credential record for the Google Drive spoke**
Create Credential records to connect the Google Drive custom OAuth application you created during Google Drive account configuration. The Google Drive spoke connection and credential aliases use these credentials to authorize actions.

1. Navigate to **IntegrationHub > Connections & Credentials > Credentials** and click **New**.
2. Select OAuth 2.0 Credentials.
3. Enter a unique name for the credential, for example, `gDrive Cred`. 
4. Click the **OAuth Entity Profile** search icon and select the profile with the name of the OAuth application registry you created when you registered the Google Drive service as an OAuth provider.

5. Click **Get Oauth Token**.

*Create Connection record for the Google Drive spoke*

Create connection records to a Google Drive account. A connection alias resolves your Google Drive connection and credential at runtime. Only one connection is active per Connection Alias at a time.

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Select the Google Drive connection.
3. On the Connection Attributes related list, set the default value of the API version to v3.
   
   If there are no connection attributes, click **New** and create a connection attribute with this information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>API version</td>
</tr>
<tr>
<td>Column name</td>
<td>u_api_version</td>
</tr>
<tr>
<td>Mandatory</td>
<td>False</td>
</tr>
<tr>
<td>Read only</td>
<td>False</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
</tr>
<tr>
<td>Reference</td>
<td>(empty)</td>
</tr>
<tr>
<td>Default value</td>
<td>v3</td>
</tr>
</tbody>
</table>

4. In the Connections related list, select **gDrive Connection**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name gDrive Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential name you specified when you created the Credential record. The value used in the steps above is gDrive Cred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Select the value sn_googledrive_spoke.Google_Drive</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter the URL <a href="https://www.googleapis.com/">https://www.googleapis.com/</a></td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select Client Credentials.</td>
</tr>
</tbody>
</table>

5. Return to **IntegrationHub > Connections & Credentials > Credentials** and select **googledrive_cred**.

6. From Related Links, click **Get OAuth Token**.
   
   A confirmation message indicates that the OAuth token flow has completed successfully. Review the details if the flow is not successful.

   **Note:** Ensure that you allow pop-up windows in your browser.

The Google Drive spoke is set up and integrated with the ServiceNow instance.
Gmail spoke

As the email service of G Suite, you can use the Gmail spoke to manage Gmail actions for individual users or for group email accounts.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Supported versions

API version v1.

Spoke subflows

The Gmail spoke provides sample subflows in the draft state to demonstrate automating Gmail tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move a ServiceNow attachment to Gmail</td>
<td>Copies an attachment from ServiceNow to Gmail.</td>
</tr>
</tbody>
</table>

Spoke actions

The Gmail spoke provides actions to automate Gmail tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label Management</td>
<td>Add Label to Email</td>
<td>Add a label to an email.</td>
</tr>
<tr>
<td></td>
<td>Create New Label</td>
<td>Create a label in your Gmail account.</td>
</tr>
<tr>
<td></td>
<td>Lookup Label ID By Name</td>
<td>Retrieve details of a specified Label ID.</td>
</tr>
<tr>
<td></td>
<td>Remove Label From Email</td>
<td>Remove the specified label from an email.</td>
</tr>
<tr>
<td>Email Management</td>
<td>Add Attachment To ServiceNow</td>
<td>Add an attachment from an email in your Gmail account to a ServiceNow record.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Email Details</td>
<td>Retrieve details of a specified email.</td>
</tr>
<tr>
<td></td>
<td>Look Up Emails</td>
<td>Retrieve details of specified emails.</td>
</tr>
<tr>
<td></td>
<td>Reply To Email</td>
<td>Send a reply to an email.</td>
</tr>
<tr>
<td></td>
<td>Send Email</td>
<td>Send email from your Gmail account to specified recipients.</td>
</tr>
<tr>
<td></td>
<td>Delete Email</td>
<td>Delete the specified email.</td>
</tr>
<tr>
<td></td>
<td>Undelete Email</td>
<td>Retrieve the specified email from the Bin.</td>
</tr>
</tbody>
</table>

**Gmail spoke account requirements**

The Gmail spoke requires a custom app that you create in the Google Developers Console.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Credentials and connection information.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Gmail alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up Gmail spoke**

Integrate the ServiceNow instance and Gmail spoke by using Google credentials to authenticate ServiceNow requests.

- Install the Gmail spoke.
- Request IntegrationHub subscription.
- Activate the Gmail spoke.
- Role required: admin.

*Configure Gmail application*

Create a custom OAuth application from your Gmail account to enable OAuth 2.0 authentication with the Gmail spoke.

Google Tasks integration requirements:

- A domain and an email address associated with the domain. For example, www.mydomain.com and jane-admin@mydomain.com. Note that you can only register one email address per domain in G Suite.
- A Google G Suite or Gmail login created with the domain.
Complete these steps from the Google Developers Console. See the G Suite product documentation for instructions on creating and configuring custom applications.

1. Register a new custom application. Navigate to https://console.developers.google.com, create a project with your G Suite administrator credentials, and open the project.
2. From the APIs & Services menu, select OAuth consent screen, enter the application name, and specify the Authorized domain service-now.com. Click Save.
3. From the APIs & Services menu, select Credentials, and select Create OAuth client ID from the Create credentials list.
4. Select the application type Web application.
5. Enter the following Authorized redirect URI: https://<instance>.service-now.com/oauth_redirect.do and click Create.
6. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register Gmail as an OAuth provider.

   The client ID and secret can always be accessed in the Google APIs & Services interface. Click Credentials and select the OAuth 2.0 client ID name.

Register Gmail as an OAuth provider
Use the information generated during Gmail application configuration to register the Gmail application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

1. In ServiceNow, navigate to System OAuth > Application Registry.
2. Open the GMail spoke.
3. Enter these values in the Application Registries form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Enter the Client ID of the Gmail application you created.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret of the Gmail application you created.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>Click the lock icon, enter https://&lt;instance&gt;.service-now.com/oauth_redirect.do, and then click the lock icon again.</td>
</tr>
</tbody>
</table>

4. In the OAuth Entity Scopes related list, add the scopes required by your application. The Gmail spoke supports these scopes:

<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>labels</td>
<td><a href="https://www.googleapis.com/auth/gmail.labels">https://www.googleapis.com/auth/gmail.labels</a></td>
</tr>
<tr>
<td>send</td>
<td><a href="https://www.googleapis.com/auth/gmail.send">https://www.googleapis.com/auth/gmail.send</a></td>
</tr>
<tr>
<td>readonly</td>
<td><a href="https://www.googleapis.com/auth/gmail.readonly">https://www.googleapis.com/auth/gmail.readonly</a></td>
</tr>
<tr>
<td>compose</td>
<td><a href="https://www.googleapis.com/auth/gmail.compose">https://www.googleapis.com/auth/gmail.compose</a></td>
</tr>
<tr>
<td>insert</td>
<td><a href="https://www.googleapis.com/auth/gmail.insert">https://www.googleapis.com/auth/gmail.insert</a></td>
</tr>
<tr>
<td>modify</td>
<td><a href="https://www.googleapis.com/auth/gmail.modify">https://www.googleapis.com/auth/gmail.modify</a></td>
</tr>
<tr>
<td>metadata</td>
<td><a href="https://www.googleapis.com/auth/gmail.metadata">https://www.googleapis.com/auth/gmail.metadata</a></td>
</tr>
<tr>
<td>basic settings</td>
<td><a href="https://www.googleapis.com/auth/gmail.settings.basic">https://www.googleapis.com/auth/gmail.settings.basic</a></td>
</tr>
<tr>
<td>Name</td>
<td>OAuth scope</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>sharing settings</td>
<td><a href="https://www.googleapis.com/auth/gmail.settings.sharing">https://www.googleapis.com/auth/gmail.settings.sharing</a></td>
</tr>
<tr>
<td>mail</td>
<td><a href="https://mail.google.com">https://mail.google.com</a></td>
</tr>
</tbody>
</table>

**Note:** The mail scope provides full access to the account including permanent deletion of threads and messages.

Click **Insert a new row** and enter the name and the OAuth scope URL.

5. On the **OAuth Entity Profiles** tab, add at least one profile, set its **Is default** value to true, and select the **Grant type** Authorization Code. Click **Update**.
6. Open the form for this default profile, add the entity scopes to the profile, and click **Update**.

7. On the Application registries form, click **Update** again.
   The system validates the OAuth credentials.

**Create Credential record for the Gmail spoke.**

Create Credential records to connect Gmail to the custom Gmail OAuth application. The Gmail spoke connection and credential alias uses these credentials to authorize actions.

- Role required: admin.

1. Navigate to **IntegrationHub > Connections & Credentials > Credentials** and click **New**.
2. Select **OAuth 2.0 Credentials**.
3. Enter a unique name for the credential, for example, *Gmail Spoke Credential*.
4. Click the **OAuth Entity Profile** search icon and select the default Gmail profile.
5. Click **Submit** and reopen the credential.
6. In Related Links, click **Get OAuth Token**.
7. Choose the Google account that the application is associated with and allow Google to access the spoke actions you specified.

**Create Connection record for the Gmail spoke.**

Create Connection records to connect a Gmail account. The Gmail spoke connection and credential alias uses these connections to perform actions in Gmail.

Role required: admin

1. Navigate to **IntegrationHub > Connections & Credentials > Connection & Credential Aliases** and select *Gmail*.
2. On the **Connections** related list, click **New**.
3. Select **HTTP(s) Connection**.
4. Provide this connection information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name <em>gmail</em>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the name of the credential you created in Create Credential record for the Gmail spoke.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter the URL <a href="https://www.googleapis.com">https://www.googleapis.com</a>. Note: Make sure that you don't include spaces before or after this URL. If there are spaces, the connection fails.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

The Gmail spoke is set up and integrated with the ServiceNow instance.
Google Tasks spoke

Google Tasks is the task management service from G Suite. Use the Google Tasks Spoke to manage Google Task actions.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Supported versions

API version v1.

Spoke subflows

The Google Tasks spoke provides sample subflows in the draft state to demonstrate automating Google Tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move a ServiceNow attachment to Google Tasks</td>
<td>Copies an attachment from ServiceNow to Google Tasks.</td>
</tr>
</tbody>
</table>

Spoke actions

The Google Tasks spoke provides actions to automate Google Tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Management</td>
<td>Complete Task</td>
<td>Mark a task complete in a task list.</td>
</tr>
<tr>
<td></td>
<td>Create Task</td>
<td>Create a task in a task list.</td>
</tr>
<tr>
<td></td>
<td>Delete Task</td>
<td>Delete a task from a task list.</td>
</tr>
<tr>
<td></td>
<td>Get Task</td>
<td>Retrieve details of a specified task from a task list.</td>
</tr>
<tr>
<td></td>
<td>Look Up Tasks</td>
<td>Retrieve details of specified tasks from a task list.</td>
</tr>
<tr>
<td></td>
<td>Update Task</td>
<td>Update details of the specified task in a task list.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Task List Management</td>
<td>Create Task List</td>
<td>Create a task list in your Google Tasks account.</td>
</tr>
<tr>
<td></td>
<td>Delete Task List</td>
<td>Delete the specified task list.</td>
</tr>
<tr>
<td></td>
<td>Get All Task Lists</td>
<td>Retrieve the details of all task lists in your Google Tasks account.</td>
</tr>
<tr>
<td></td>
<td>Get Task List</td>
<td>Retrieve details of a specified task list.</td>
</tr>
<tr>
<td></td>
<td>Update Task List</td>
<td>Update details of a specified task list.</td>
</tr>
</tbody>
</table>

**Google Tasks account requirements**

The Google Tasks spoke requires a custom app that you create in the Google Developers Console.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Credentials and connection information.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Google Tasks alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up Google Tasks spoke**

Integrate the ServiceNow instance and Google Tasks spoke by using G Suite credentials to authenticate ServiceNow requests.

- Install the Google Tasks spoke.
- Request IntegrationHub subscription.
- Activate the Google Tasks spoke.
- Role required: admin.

*Configure Google Tasks application*

Create a custom OAuth application from your Gmail account to enable OAuth 2.0 authentication with the Google Tasks spoke.

Google Tasks integration requirements:

- A domain and an email address associated with the domain. For example, www.mydomain.com and jane-admin@mydomain.com. Note that you can only register one email address per domain in G Suite.
- A Google G Suite or Gmail login created with the domain.
Complete these steps from the Google Developers Console. See the G Suite product documentation for instructions on creating and configuring custom applications.

1. Register a new custom application. Navigate to https://console.developers.google.com, create a project with your G Suite administrator credentials, and open the project.
2. From the APIs & Services menu, select OAuth consent screen, enter the application name, and specify the Authorized domain service-now.com. Click Save.
3. From the APIs & Services menu, select Credentials, and select Create OAuth client ID from the Create credentials list.
4. Select the application type Web application.
5. Enter the following Authorized redirect URI: https://<instance>.service-now.com/oauth_redirect.do and click Create.
6. The OAuth client window shows your client ID and client secret. Copy these two values to a text file so that you can use them when you Register Google Tasks as an OAuth provider.

The client ID and secret can always be accessed in the Google APIs & Services interface. Click Credentials and select the OAuth 2.0 client ID name.

Register Google Tasks as an OAuth provider

Use the information generated during Google Tasks application configuration to register the Google Tasks application as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

1. In ServiceNow, navigate to System OAuth > Application Registry.
2. Open the Google Tasks spoke.
3. Enter these values in the Application Registries form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Enter the Client ID of the Google Tasks application you created.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret of the Google Tasks application you created.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>Click the lock icon. Enter https://&lt;instance&gt;.service-now.com/oauth_redirect.do, and then click the lock icon again.</td>
</tr>
</tbody>
</table>

4. In the OAuth Entity Scopes related list, add the scopes required by your application. The Google Tasks spoke supports two scopes:

<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>tasks</td>
<td><a href="https://www.googleapis.com/auth/tasks">https://www.googleapis.com/auth/tasks</a></td>
</tr>
</tbody>
</table>
Click **Insert a new row** and enter a name for the scope and the OAuth scope.

<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>readonly</td>
<td><a href="https://www.googleapis.com/auth/tasks.readonly">https://www.googleapis.com/auth/tasks.readonly</a></td>
</tr>
</tbody>
</table>

5. On the **OAuth Entity Profiles** tab, add at least one profile, set its **Is default** value to true, and select the **Grant type** Authorization Code. Click **Update**.
6. Open the form for this default profile, add the entity scopes to the profile, and click **Update**.
7. On the Application registries form, click **Update** again. The system validates the OAuth credentials.

Create Credential record for the Google Tasks spoke.

**Create Credential record for the Google Tasks spoke**
Create Credential records to connect Google Tasks the custom Google Tasks OAuth application. The Google Tasks spoke connection and credential alias uses these credentials to authorize actions.

Role required: admin.

1. Navigate to **IntegrationHub** > **Connections & Credentials** > **Credentials** and click **New**.
2. Select **OAuth 2.0 Credentials**.
3. Enter a unique name for the credential, for example, **Google Tasks Spoke Credential**.
4. Click the **OAuth Entity Profile** search icon
   and select the default Google Task profile.
5. Click **Submit** and reopen the credential.
6. In Related Links, click **Get OAuth Token**.
   Choose the Google account that the application is associated with and allow Google to access the
   spoke actions you specified.

Create Connection record for the Google Tasks spoke.

Create Connection record for the Google Tasks spoke
Create Connection records to your Google account. The Google Tasks spoke connection and credential
alias uses these connections to perform actions in Google Tasks.

Role required: admin

1. Navigate to **IntegrationHub > Connections & Credentials > Connection & Credential Aliases** and
   select **Google Tasks**.
2. On the **Connections** related list, click **New**.
3. Select **HTTP(s) Connection**.
4. Provide this connection information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name <strong>GTask</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the name of the credential you created in <strong>Create Credential record for the Google Tasks spoke</strong>.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter the URL <strong><a href="https://www.googleapis.com">https://www.googleapis.com</a></strong>.</td>
</tr>
</tbody>
</table>

   **Note:** Make sure that you don't include spaces before or after this URL. If there are spaces, the connection fails.

5. Click **Submit**.

The Google Tasks spoke is set up and integrated with the ServiceNow instance.

**Jenkins spoke**

Manage builds, users, settings, and jobs on the Jenkins server. Retrieve Jenkins data to use in a flow.

**Request apps on the Store**

Visit the **ServiceNow Store** website to view all the available apps and for information about submitting
requests to the store. For cumulative release notes information for all released apps, refer to the **ServiceNow Store version history release notes**.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Standard subscription package. For more information, see **Request IntegrationHub**.
### Supported versions

All versions between 1.651.1 and 2.150.3.

### Spoke actions

The Jenkins spoke provides actions to automate Jenkins tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build Management</td>
<td>Delete Build</td>
<td>Deletes a build from a Jenkins server job.</td>
</tr>
<tr>
<td></td>
<td>Get All Builds</td>
<td>Retrieves all the builds for a given Jenkins server job. Returns the URL,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>build number, and class of each build.</td>
</tr>
<tr>
<td></td>
<td>Get Build History</td>
<td>Retrieves a range of build history for a given job from Jenkins Server.</td>
</tr>
<tr>
<td></td>
<td>Get Build Information</td>
<td>Retrieves the build timestamp, build status, and complete build</td>
</tr>
<tr>
<td></td>
<td></td>
<td>information of a given job from the Jenkins server.</td>
</tr>
<tr>
<td></td>
<td>Get Build Number</td>
<td>Retrieves the build number for a Jenkins server job based on a pre-defined</td>
</tr>
<tr>
<td></td>
<td></td>
<td>build filter, such as last successful build.</td>
</tr>
<tr>
<td></td>
<td>Perform a Build</td>
<td>Executes a job on the Jenkins server.</td>
</tr>
<tr>
<td>Configuration Management</td>
<td>Create Jenkins Credentials</td>
<td>Creates Jenkins server credentials.</td>
</tr>
<tr>
<td></td>
<td>Create Node</td>
<td>Creates a node that you can launch with Java Web Start software. A node is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>a machine that is part of the Jenkins environment and capable of executing</td>
</tr>
<tr>
<td></td>
<td>Delete Node</td>
<td>Deletes a node from the Jenkins server.</td>
</tr>
<tr>
<td></td>
<td>Get CSRF Token</td>
<td>Retrieves a CSRF token if your Jenkins server has the &quot;Prevent Cross Site</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Request Forgery exploits&quot; option enabled.</td>
</tr>
<tr>
<td></td>
<td>Get Version</td>
<td>Retrieves the Jenkins server version.</td>
</tr>
<tr>
<td></td>
<td>Restart Jenkins</td>
<td>Restarts the Jenkins server.</td>
</tr>
<tr>
<td></td>
<td>Test Connection</td>
<td>Tests the connection to the Jenkins server.</td>
</tr>
<tr>
<td>Job Management</td>
<td>Copy Job</td>
<td>Creates a job by copying an existing Jenkins server job.</td>
</tr>
<tr>
<td></td>
<td>Create Folder</td>
<td>Creates a Jenkins server folder to organize jobs.</td>
</tr>
<tr>
<td></td>
<td>Create Job</td>
<td>Creates a Jenkins server job from an XML file.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delete Folder</td>
<td>Deletes an existing Jenkins server folder.</td>
</tr>
<tr>
<td></td>
<td>Delete Job</td>
<td>Deletes a Jenkins server job.</td>
</tr>
<tr>
<td></td>
<td>Get All Jobs From Folder</td>
<td>Retrieves all the jobs from a given Jenkins server folder. Returns the class and name of each job up to the specified number of levels.</td>
</tr>
<tr>
<td></td>
<td>Get Build Timestamp</td>
<td>Retrieves the build timestamp of a specified Jenkins server job.</td>
</tr>
<tr>
<td></td>
<td>Get Console Output</td>
<td>Retrieves the build console output of a specified Jenkins server job.</td>
</tr>
<tr>
<td></td>
<td>Get Job Configuration</td>
<td>Retrieves the XML configuration for a Jenkins server job.</td>
</tr>
<tr>
<td></td>
<td>Reload Job</td>
<td>Reloads a Jenkins server job.</td>
</tr>
<tr>
<td></td>
<td>Rename Job</td>
<td>Renames a Jenkins server job.</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates a Jenkins server user.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes an existing Jenkins server user.</td>
</tr>
<tr>
<td>View Management</td>
<td>Add Job To View</td>
<td>Adds a job to the Jenkins server view. Views are containers to organize jobs. As a Jenkins instance grows, you can create views for appropriate groups and categories. For example, you may want to create a Build view, which only displays build-specific jobs.</td>
</tr>
<tr>
<td></td>
<td>Create View</td>
<td>Creates a Jenkins server view.</td>
</tr>
<tr>
<td></td>
<td>Delete View</td>
<td>Deletes a Jenkins server view.</td>
</tr>
<tr>
<td></td>
<td>Get All Jobs From View</td>
<td>Retrieves all jobs from a Jenkins server view. Returns the class and name of top-level jobs.</td>
</tr>
<tr>
<td></td>
<td>Remove Job From View</td>
<td>Removes a job from a Jenkins server view.</td>
</tr>
</tbody>
</table>

**Support for CSRF tokens**

If your Jenkins server has the "Prevent Cross Site Request Forgery exploits" option enabled, certain actions require a unique token. Use the Get CSRF Token action to retrieve a token for use by the rest of the flow. The action outputs the token as a data pill for use in other actions in the flow.

**Connection and credential requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see [Credentials and connection information](#).

This spoke uses the Jenkins Connection & Credential Alias record to authorize actions. To use the spoke connection alias, create an associated Connection record and an associated Credential record.
MID Server requirements

These actions use REST calls, which run on a MID Server. Use the connection record associated with the Jenkins alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

Set up Jenkins spoke

Integrate the ServiceNow instance and Jenkins using basic authentication to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Activate Jenkins spoke
- Role required: admin

Create Credential records for the Jenkins spoke

Create Credential records to the Jenkins server. The Jenkins spoke connection and credential alias uses these credentials to authorize actions.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select Basic Auth Credentials.
   A blank Basic Auth Credentials form displays.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Jenkins Credentials.</td>
</tr>
<tr>
<td>User name</td>
<td>Your Jenkins user name.</td>
</tr>
<tr>
<td>Password</td>
<td>Your Jenkins password.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create Connection records for the Jenkins spoke

Create Connection records to your Jenkins account. The Jenkins spoke connection and credential alias uses these connections to perform actions on Jenkins.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Jenkins.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Jenkins Connection.</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Jenkins. For example, select Jenkins Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>The URL of the host machine where Jenkins is installed.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Jira spoke**

Manage issues, users, stories, and groups in Jira. Retrieve Jira data to use in a flow.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**Note:** This version of the Jira spoke is deprecated. See Jira spoke v2.5.7 for information about the next version of the spoke.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

**Supported versions**

API version v2.

**Spoke actions**

Use actions in the Jira spoke in Flow Designer to automate Jira tasks when an event occurs in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue Management</td>
<td>Add Attachment</td>
<td>Adds an attachment to the specified issue in Jira.</td>
</tr>
<tr>
<td></td>
<td>Add Comment</td>
<td>Adds a comment to the specified issue in Jira.</td>
</tr>
<tr>
<td></td>
<td>Assign Issue</td>
<td>Assigns the issue in Jira to the user.</td>
</tr>
<tr>
<td></td>
<td>Create Issue</td>
<td>Creates an issue in Jira. Depending on how your organization is using Jira, an issue could represent a software bug, a project task, a help desk ticket, or more. An issue in Jira represents a task in the Now Platform.</td>
</tr>
<tr>
<td></td>
<td>Delete Issue</td>
<td>Deletes an issue in Jira.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Do Transition</td>
<td>Transitions an issue in Jira from one state to another.</td>
</tr>
<tr>
<td></td>
<td>Edit Issue</td>
<td>Updates a set number of fields of an issue in Jira with values passed as input.</td>
</tr>
<tr>
<td>Project Management</td>
<td>Get All Projects</td>
<td>Retrieves information in JSON format for all projects visible to the currently logged in user. A project in Jira is a collection of issues, and is defined according to your organization's requirements.</td>
</tr>
<tr>
<td></td>
<td>Get All Stories</td>
<td>Retrieves information in JSON format for all stories within a specified date range.</td>
</tr>
<tr>
<td></td>
<td>Get All Transitions</td>
<td>Retrieves in JSON format for all Transitions information from a given Issue ID.</td>
</tr>
<tr>
<td>SDLC Management</td>
<td>Create Story</td>
<td>Creates a story in Jira, similar to a story in Now Platform Agile Development.</td>
</tr>
<tr>
<td></td>
<td>Update Story</td>
<td>Updates a set number of fields of a story in Jira with values passed as input.</td>
</tr>
<tr>
<td>User Management</td>
<td>Get Users</td>
<td>Fetches a list in JSON format of all active JIRA users.</td>
</tr>
<tr>
<td></td>
<td>Create User</td>
<td>Creates a new user in JIRA.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• This action uses an experimental API and hence, is not officially supported.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Upon deleting an existing user, if a new user is created with the same previously deleted email address but with different name and username, the newly created user record contains the details of the deleted user. Also, an error is displayed in the flow execution details.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Set Show draft actions to true from the More Actions menu to use this action.</td>
</tr>
<tr>
<td>Group Management</td>
<td>Add User to Group</td>
<td>Adds given user to a group in Jira.</td>
</tr>
<tr>
<td></td>
<td>Create Group</td>
<td>Creates a group in Jira.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Users From Group</td>
<td>Retrieves a list of users who are members of the specified group and its subgroups in Jira.</td>
</tr>
<tr>
<td></td>
<td>Remove Group</td>
<td>Removes the given group from Jira.</td>
</tr>
<tr>
<td></td>
<td>Remove User from Group</td>
<td>Removes the given user from a group in Jira.</td>
</tr>
</tbody>
</table>

**Jira account requirements**

The Jira spoke requires generating an API token for Jira using your Atlassian Account.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Credentials and connection information.

⚠️ **Note:** The Jira spoke in this release does not manage OAuth credentials.

This spoke uses the Jira alias record. To use these actions, you must create a Connection record and a Credential record and associate them with the Jira alias record.

These actions use REST calls, which can run on an instance. Use the connection record associated with the Jira alias to configure the endpoint against which the actions will run.

**Set up Jira spoke**

Integrate the ServiceNow instance and Jira using an API key to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Activate Jira spoke
- Role required: admin

**Generate Jira account API token**

Generate an access token from your Jira (Atlassian) account for API key authentication.

Jira requirements:

- Atlassian account
- Atlassian administrator credentials

Complete these steps from your Atlassian account. See the Atlassian Developer portal documentation for instructions on generating your API token.

1. From your Atlassian account, generate an access token to interact with Jira APIs.
2. Copy and record the access token to create Credential records on your ServiceNow instance.

**Create Credential records for the Jira spoke**

Create a Credential record for the Jira account. The Jira spoke connection and credential alias uses this credential to authorize actions.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
The system displays the message **What type of Credentials would you like to create?**

3. Select **Basic Auth Credentials**.
   The pop-up window displays a blank Basic Auth Credentials form.
4. Enter these values, then click **Submit**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Jira Credentials.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name for the Jira account.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the API token you generated for Jira.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Search for and select the Jira credential alias.</td>
</tr>
</tbody>
</table>

**Create Connection records for the Jira spoke**
Create a Connection record for the Jira account. The Jira spoke connection and credential alias uses this connection to perform actions in Jira.

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the alias record for **Jira** that shipped with the spoke.
3. From the **Connections** tab, click **New**.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values and click **Submit**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Jira Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record created for Jira. For example, select Jira Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Search for and select the Jira alias.</td>
</tr>
</tbody>
</table>
| Connection URL | • For Jira cloud application, enter the URL of your Jira instance  
   • For Jira on-premise application, enter https://<server_host>:<port>. |
| Use MID server | Option to use MID Server.  
   **Note:** This option is applicable only for Jira on-premise application. |
| Active         | Enable                                                                         |

**Jira spoke v2.5.7**
Manage issues, users, stories, and groups in Jira. Retrieve Jira data to use in a flow. Use bi-directional webhooks and subscribe to Jira with a ServiceNow callback URL.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Integrations - External Authentication Framework (com.glide.external.app)

**Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported versions

This spoke was built for API version v2, but may be compatible with later versions.

**Note:** If your Jira instance supports another API version, specify the API version in API Version under the Attributes related list. By default, API Version is 2. See Create Connection records for the Jira spoke for information about creating a Connection record.

Spoke requirements

Activate the Integrations - External Authentication Framework (com.glide.external.app) plugin.

Jira Webhooks module

Bi-directional webhooks can be setup to be notified about the required events. Routing policy defines conditions that must be met to notify the ServiceNow app. These conditions are based on the events in Jira for which you wish to be notified about. When the conditions are met, routing policy triggers the associated subflow, which in turn automates the Jira tasks.

The bi-directional webhooks requires separate setup and can be used independently without using the spoke actions. By default, the Jira Webhooks application is available in the Jira spoke and has the following modules:

- Jira Webhook Registries
- Jira WebHook Routing Policies
Use the Jira Webhook Registries module to assign a token and provide the API path. You must generate Callback URL here and provide this URL in Jira. A default routing policy is provided in the Jira WebHook Routing Policies module. The default routing policy supports these fields:

<table>
<thead>
<tr>
<th>Category</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Jira Instance URL</td>
</tr>
<tr>
<td></td>
<td>• Webhook Event</td>
</tr>
<tr>
<td></td>
<td>• Issue Description</td>
</tr>
<tr>
<td></td>
<td>• Created</td>
</tr>
<tr>
<td></td>
<td>• Updated</td>
</tr>
<tr>
<td></td>
<td>• Issue Resolution</td>
</tr>
<tr>
<td></td>
<td>• Previous Issue Resolution</td>
</tr>
<tr>
<td></td>
<td>• Issue Summary</td>
</tr>
<tr>
<td></td>
<td>• Issue Type</td>
</tr>
<tr>
<td></td>
<td>• Previous Issue Type</td>
</tr>
<tr>
<td></td>
<td>• Issue Priority</td>
</tr>
<tr>
<td></td>
<td>• Previous Issue Priority</td>
</tr>
<tr>
<td></td>
<td>• Issue Status</td>
</tr>
<tr>
<td></td>
<td>• Previous Issue Status</td>
</tr>
<tr>
<td></td>
<td>• Issue Status Category</td>
</tr>
<tr>
<td></td>
<td>• Previous Issue Status Category</td>
</tr>
<tr>
<td></td>
<td>• Project</td>
</tr>
<tr>
<td>Comment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Jira Instance URL</td>
</tr>
<tr>
<td></td>
<td>• Webhook Event</td>
</tr>
<tr>
<td></td>
<td>• Comment</td>
</tr>
<tr>
<td></td>
<td>• Created</td>
</tr>
<tr>
<td></td>
<td>• Updated</td>
</tr>
<tr>
<td></td>
<td>• Issue Summary</td>
</tr>
<tr>
<td></td>
<td>• Issue Type</td>
</tr>
<tr>
<td></td>
<td>• Issue Priority</td>
</tr>
<tr>
<td></td>
<td>• Issue Status</td>
</tr>
<tr>
<td></td>
<td>• Issue Status Category</td>
</tr>
<tr>
<td></td>
<td>• Project</td>
</tr>
<tr>
<td>Worklog</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Jira Instance URL</td>
</tr>
<tr>
<td></td>
<td>• Webhook Event</td>
</tr>
<tr>
<td></td>
<td>• Worklog Time Spent</td>
</tr>
<tr>
<td></td>
<td>• Created</td>
</tr>
<tr>
<td></td>
<td>• Updated</td>
</tr>
<tr>
<td>Attachment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Jira Instance URL</td>
</tr>
<tr>
<td></td>
<td>• Webhook Event</td>
</tr>
<tr>
<td></td>
<td>• Created</td>
</tr>
<tr>
<td></td>
<td>• Attachment File Name</td>
</tr>
<tr>
<td></td>
<td>• Attachment Size</td>
</tr>
<tr>
<td></td>
<td>• Attachment Mime Type</td>
</tr>
</tbody>
</table>
To use other conditions in the routing policy, create routing policy in the Jira WebHook Routing Policies module and specify conditions as per your requirement. See Set up bi-directional webhook for the Jira spoke v2.5.7 for information regarding setting up and configuring the webhooks.

**Spoke subflow**

The Jira spoke provides a sample subflow to handle various Jira webhook events. Available sample subflow is, Process Jira Webhooks. The Process Jira Webhooks subflow supports these fields:

<table>
<thead>
<tr>
<th>Category</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue</td>
<td>• User</td>
</tr>
<tr>
<td></td>
<td>• Issue</td>
</tr>
<tr>
<td></td>
<td>• Attachments</td>
</tr>
<tr>
<td></td>
<td>• Issue Change Log</td>
</tr>
<tr>
<td></td>
<td>• Project</td>
</tr>
<tr>
<td>Comment</td>
<td>• Issue</td>
</tr>
<tr>
<td></td>
<td>• Project</td>
</tr>
<tr>
<td></td>
<td>• Comment</td>
</tr>
<tr>
<td>Worklog</td>
<td>Worklog</td>
</tr>
<tr>
<td>Attachments</td>
<td>Attachment</td>
</tr>
<tr>
<td>Project</td>
<td>Project</td>
</tr>
<tr>
<td>Version</td>
<td>Version</td>
</tr>
<tr>
<td>Webhook Event</td>
<td></td>
</tr>
<tr>
<td>Timestamp</td>
<td></td>
</tr>
<tr>
<td>Payload</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** This is the entire Jira payload.
To customize the default subflow, you must create a copy of the sample subflow, parse the payload, and customize the subflow as per your requirement. Payload is one of the inputs to the subflow.

While customizing subflows, you must ensure that the subflows are configured to avoid infinite loops.

**Note:**
- You must configure webhooks to use the spoke subflow. See Set up bi-directional webhook for the Jira spoke v2.5.7 for information regarding setting up and configuring the webhook.
- The sample subflow runs as a user by default. It can be configured to run as system.

**Spoke actions**

Use actions in the Jira spoke in Flow Designer to automate Jira tasks when an event occurs in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue Management</td>
<td>Copy Attachment</td>
<td>Copies the required attachment associated with the ServiceNow record to the required issue in Jira.</td>
</tr>
<tr>
<td></td>
<td>Delete Attachment</td>
<td>Deletes the required attachment in Jira.</td>
</tr>
<tr>
<td></td>
<td>Add Comment</td>
<td>Adds a comment to the specified issue in Jira.</td>
</tr>
<tr>
<td></td>
<td>Assign Issue</td>
<td>Assigns the issue in Jira to the user.</td>
</tr>
<tr>
<td></td>
<td>Create Issue</td>
<td>Creates an issue in Jira. Depending on how your organization is using Jira, an issue could represent a software bug, a project task, a help desk ticket, or more. An issue in Jira represents a task in the Now Platform.</td>
</tr>
<tr>
<td></td>
<td>Delete Issue</td>
<td>Deletes an issue in Jira.</td>
</tr>
<tr>
<td></td>
<td>Do Transition</td>
<td>Transitions an issue in Jira from one state to another.</td>
</tr>
<tr>
<td></td>
<td>Get Issue By ID</td>
<td>Retrieves the JSON object of the required issue.</td>
</tr>
<tr>
<td></td>
<td>Look Up Records By JQL</td>
<td>Retrieves the list of the required records by providing a JQL query.</td>
</tr>
<tr>
<td></td>
<td>Look Up Transitions</td>
<td>Retrieves information about all Transitions in JSON format for a given Issue ID.</td>
</tr>
<tr>
<td></td>
<td>Update Issue</td>
<td>Updates a set number of fields of an issue in Jira with values passed as input.</td>
</tr>
<tr>
<td></td>
<td>Get Issues</td>
<td>Gets a list of Jira issues.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Issues for Sprint</td>
<td>Retrieves the details of all issues for the given sprint.</td>
</tr>
<tr>
<td>Project Management</td>
<td>Get All Projects</td>
<td>Retrieves information in JSON format for all projects visible to the currently logged in user. A project in Jira is a collection of issues, and is defined according to your organization’s requirements.</td>
</tr>
<tr>
<td>SDLC Management</td>
<td>Create Story</td>
<td>Creates a story in Jira, similar to a story in Now Platform Agile Development.</td>
</tr>
<tr>
<td></td>
<td>Look Up Stories</td>
<td>Retrieves information in JSON format for all stories within a specified date range.</td>
</tr>
<tr>
<td></td>
<td>Update Story</td>
<td>Updates a set number of fields of a story in Jira with values passed as input.</td>
</tr>
<tr>
<td>User Management</td>
<td>Look Up Users</td>
<td>Fetches a list in JSON format of all active Jira users.</td>
</tr>
<tr>
<td></td>
<td>Create User</td>
<td>Creates a new user in Jira.</td>
</tr>
<tr>
<td></td>
<td>Remove User</td>
<td>Removes a user from Jira.</td>
</tr>
<tr>
<td></td>
<td>Get Jira Users</td>
<td>Gets all Jira user subscriptions.</td>
</tr>
<tr>
<td></td>
<td>Get Jira User Activity</td>
<td>Retrieves the details of user activity in Jira.</td>
</tr>
<tr>
<td></td>
<td>Get Audit Log</td>
<td>Gets audit log activity for Jira user subscriptions.</td>
</tr>
<tr>
<td>Group Management</td>
<td>Add User to Group</td>
<td>Adds given user to a group in Jira.</td>
</tr>
<tr>
<td></td>
<td>Create Group</td>
<td>Creates a group in Jira.</td>
</tr>
<tr>
<td></td>
<td>Look Up Users By Group</td>
<td>Retrieves a list of users who are members of the specified group and its subgroups in Jira.</td>
</tr>
<tr>
<td></td>
<td>Remove Group</td>
<td>Removes the given group from Jira.</td>
</tr>
<tr>
<td></td>
<td>Remove User from Group</td>
<td>Removes the given user from a group in Jira.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Creatable Fields</td>
<td>Retrieves the list of all fields in a required Jira project.</td>
</tr>
<tr>
<td></td>
<td>Get Editable Fields</td>
<td>Retrieves the list of all editable fields in a required Jira issue.</td>
</tr>
<tr>
<td></td>
<td>Get Issue Types</td>
<td>Retrieves the list of all issue types in a required Jira project.</td>
</tr>
<tr>
<td></td>
<td>Get Projects</td>
<td>Retrieves the list of all Jira projects.</td>
</tr>
<tr>
<td></td>
<td>Get All Boards</td>
<td>Retrieves the details of all boards in Jira.</td>
</tr>
<tr>
<td>Sprint Management</td>
<td>Create Sprint</td>
<td>Creates a sprint in Jira.</td>
</tr>
<tr>
<td></td>
<td>Delete Sprint</td>
<td>Deletes a sprint in Jira.</td>
</tr>
<tr>
<td></td>
<td>Get All Sprints By Board</td>
<td>Retrieves the details of all sprints in the required board.</td>
</tr>
<tr>
<td></td>
<td>Get Sprint By ID</td>
<td>Retrieves the details of the required sprint as a JSON object.</td>
</tr>
<tr>
<td></td>
<td>Update Sprint</td>
<td>Updates the details of a sprint in Jira.</td>
</tr>
</tbody>
</table>
Jira account requirements

The Jira spoke requires generating an API token for Jira using your Atlassian Account.

Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Credentials and connection information.

This spoke uses the Jira alias record. To use these actions, you must create a Connection record and a Credential record and associate them with the Jira alias record.

These actions use REST calls, which can run on an instance. Use the connection record associated with the Jira alias to configure the endpoint against which the actions will run.

Set up Jira spoke v2.5.7

Integrate the ServiceNow instance and Jira using an API key to authenticate ServiceNow requests.

- Request IntegrationHub Standard subscription
- Activate the Jira spoke v2.5.7
- Role required: admin

You can integrate ServiceNow instance with multiple Jira instances. For this, you must create a connection and credential alias record and connection record for each Jira instance.

Generate Jira account API token

Generate an access token from your Jira (Atlassian) account for API key authentication.

Jira requirements:

- Atlassian account
- Atlassian administrator credentials

Complete these steps from your Atlassian account. See the Atlassian Developer portal documentation for instructions on generating your API token.

1. From your Atlassian account, generate an access token to interact with Jira APIs.
2. Copy and record the access token to create Credential records on your ServiceNow instance.

Create Credential records for the Jira spoke

Create a Credential record for the Jira account. The Jira spoke connection and credential alias uses this credential to authorize actions.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?
3. Select Basic Auth Credentials.
   The pop-up window displays a blank Basic Auth Credentials form.
4. Enter these values, then click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Jira Credentials.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the email address of the user.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the API token you generated for Jira.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you are using the Jira on-premise solution, enter the password.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Search for and select the Jira credential alias.</td>
</tr>
</tbody>
</table>

Create Connection records for the Jira spoke
Create a Connection record for the Jira account. The Jira spoke connection and credential alias uses this connection to perform actions in Jira.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the alias record for Jira that shipped with the spoke.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values and click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Jira Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record created for Jira. For example, select Jira Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Search for and select the Jira alias.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter the URL of your Jira instance.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
</tbody>
</table>

5. Optional: If you create a credential record to integrate ServiceNow instance with another Jira instance, ensure that api_version under the Attributes related list in the associated connection record is set to 2.

Note: If your Jira instance supports another API version, specify the API version in API Version under the Attributes related list. By default, API Version is 2.

Set up bi-directional webhook for the Jira spoke v2.5.7
Configure webhook to subscribe to Jira with a ServiceNow callback URL.
- Request IntegrationHub Standard subscription
- Activate the Jira spoke v2.5.7
- Role required: admin

Create token for the Jira spoke
Create token to embedded in the Jira webhook URL.
Role required: admin

1. In the filter navigator, enter `token_verification.list`.
   The system displays records in the Token Verifications table.
2. Click New.
3. On the form, fill the fields.

### Token Verification form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name to identify the token. For example, Jira token.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the token.</td>
</tr>
<tr>
<td>Token</td>
<td>Authentication token. This token is encrypted and embedded in the URL.</td>
</tr>
</tbody>
</table>

### Register Jira webhook in ServiceNow

Register Jira webhook in ServiceNow to notify the ServiceNow app when certain events occur in Jira.

Role required: admin

1. Navigate to Jira Webhooks > Jira Webhook Registries.
2. Click New.
3. On the form, fill in the fields.

### Jira Webhook Registry form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name to identify the record. For example, Jira webhook.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the record.</td>
</tr>
<tr>
<td>Token</td>
<td>Authentication token. This token is encrypted and embedded in the URL.</td>
</tr>
<tr>
<td>Path</td>
<td>Jira webhook path. By default, this is set to <code>api/sn_jira_spoke/jira_webhook_callbacks/wh_entry</code>.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click Save.
5. Click Callback URL.
   The system displays the Webhook Callback URL.
6. Copy and record the Webhook Callback URL.

The Jira webhook is registered in your ServiceNow instance.

### Add Callback URL in Jira

Provide Webhook Callback URL in Jira Atlassian account to create webhook.

Role required: admin

1. Log in to your Jira Atlassian account.
2. Create a webhook in your Atlassian account.
3. Enter Webhook Callback URL in URL. See the Atlassian Developer portal documentation for instructions on creating a webhook.
The Callback URL is added in the Jira Atlassian account. You can create routing policies and subflows as per your requirement. See **Customize bi-directional webhook in the Jira spoke** for information regarding creating new routing policies and subflows.

*Customize bi-directional webhook in the Jira spoke*
Create webhook routing policy and subflow as per your requirement.

Role required: admin

The default routing policy in the Jira WebHook Routing Policies modules triggers the Process Jira Webhooks subflow and notifies the ServiceNow app when certain events occur in Jira. See **Jira spoke v2.5.7** for information about the fields that the default routing policy and subflows support. To use any other fields in your custom subflow and customize conditions in the routing policy, perform these steps.

1. Navigate to **Flow Designer > Designer**.
2. Click **Subflows**.
3. Create a copy of the default subflow, Process Jira Webhooks.
4. Customize the subflow as per your requirement and publish it. See **Subflows** for more information about creating and using subflows and **Jira spoke v2.5.7** for information about the fields that the default routing policy and subflows support.
5. Navigate to **Jira Webhooks > Jira WebHook Routing Policies**.
6. Click **New**.
7. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique label to identify the routing policy.</td>
</tr>
<tr>
<td>Default answer</td>
<td>Option to specify if this is the default answer. Default answer is applicable when the conditions are not met.</td>
</tr>
<tr>
<td></td>
<td>a. Click the Lookup icon.</td>
</tr>
<tr>
<td></td>
<td>b. Select the required subflow from the <strong>Document</strong> list.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions to be met when the required events occur in Jira. See <strong>Jira webhooks</strong> for information about the supported fields.</td>
</tr>
<tr>
<td>Answer</td>
<td>Subflow that has to be triggered when the specified conditions are met.</td>
</tr>
</tbody>
</table>

8. Click **Submit**.

*Note:* These routing policies are saved in the Decision tables. Users are cautioned against directly updating or modifying data in these tables.

Routing policy and subflow are created.

**Kubernetes spoke**

Automate changes in Kubernetes when an event occurs in ServiceNow.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Supported versions

API version v1.

Spoke actions

The Kubernetes spoke provides actions to automate Kubernetes tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint Management</td>
<td>Create Endpoints</td>
<td>Creates an endpoint in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Endpoints</td>
<td>Deletes an endpoint from the Kubernetes instance.</td>
</tr>
<tr>
<td>Namespace Management</td>
<td>Create Namespace</td>
<td>Creates a namespace in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Namespace</td>
<td>Deletes a namespace from the Kubernetes instance.</td>
</tr>
<tr>
<td>Node Management</td>
<td>Create Node</td>
<td>Creates a node in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Node</td>
<td>Deletes a node in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Inspect Node</td>
<td>Inspects a specified node in the Kubernetes instance and returns node information and status.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pod Management</td>
<td>Create Pod</td>
<td>Creates a Pod in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Pod</td>
<td>Deletes a pod from the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Inspect Pod</td>
<td>Inspects the specified pod in the Kubernetes instance and returns pod information and status.</td>
</tr>
<tr>
<td>Secret Management</td>
<td>Create Docker Hub Secret</td>
<td>Creates a secret in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Docker Hub Secret</td>
<td>Deletes a Secret from the Kubernetes instance.</td>
</tr>
<tr>
<td>Service Management</td>
<td>Create Service</td>
<td>Creates a service on a Kubernetes server.</td>
</tr>
<tr>
<td></td>
<td>Delete Service</td>
<td>Deletes a service from the Kubernetes server.</td>
</tr>
<tr>
<td>Volume Management</td>
<td>Create Persistent Volume</td>
<td>Creates a persistent volume in the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Create Persistent Volume Claim</td>
<td>Creates a Persistent Volume Claim in a Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Persistent Volume</td>
<td>Deletes a persistent volume from the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Delete Persistent Volume Claim</td>
<td>Deletes a persistent volume claim from the Kubernetes instance.</td>
</tr>
<tr>
<td></td>
<td>Inspect Persistent Volume Claim</td>
<td>Inspects a persistent volume claim in a Kubernetes instance and returns claim information and status.</td>
</tr>
</tbody>
</table>

**Kubernetes account requirements**

The Kubernetes spoke requires generating and configuring your Kubernetes account to use a web API key.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Credentials and connection information.

This spoke uses the Kubernetes alias record to authorize actions. To use the spoke connection alias, create an associated Connection record and an associated Credential record.
MID Server requirements

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Kubernetes alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

Set up Kubernetes spoke

Integrate the ServiceNow instance and Kubernetes using an API key and certificate to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Activate the Kubernetes spoke
- Role required: admin

*Generate Kubernetes API token and certificate*

Generate an access token and a certificate from your Kubernetes account for API key authentication.

Kubernetes requirements:

- Kubernetes account
- Administrator credentials on the host machine where Kubernetes is installed

Complete these steps from your Kubernetes host machine. See Kubernetes documentation for instructions on generating your API token and client certificate.

1. From your Kubernetes host machine, generate an access token to interact with Kubernetes APIs. This token does not expire.
2. Copy and record the access token to create Credential records on your ServiceNow instance.
3. Generate a client certificate to upload to your ServiceNow instance.

*Upload Kubernetes client certificate*

Upload the Kubernetes client certificate to your ServiceNow instance to authenticate API requests to the Kubernetes host machine.

1. Navigate to System LDAP > Certificates.
2. Click New.
3. Complete the form and enter the certificate in the PEM Certificate field.
   - For more information about uploading certificates, see Upload a certificate to an instance.
4. Click Submit.

*Create Credential records for the Kubernetes spoke*

Create Credential records to your Kubernetes account. The Kubernetes spoke connection and credential alias uses these credentials to authorize actions.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   - The system displays the message What type of Credentials would you like to create?.
3. Select API Key Credentials.
   - A blank API Key Credentials form displays.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Kubernetes Credentials.</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>API Key</td>
<td>Enter Bearer followed by the access token you obtained from Kubernetes. For example, Bearer {access token}.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

*Create Connection records for the Kubernetes spoke*

Create Connection records to the Kubernetes engine. The Kubernetes spoke connection and credential alias uses these connections to perform actions in Kubernetes.

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open for the record for **Kubernetes**.
3. From the **Connections** tab, click **New**. The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Kubernetes Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Kubernetes. For example, select Kubernetes Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>The IP address and port of the host machine where Kubernetes is installed.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

*Turn off remote SSL host verification*

A system property prevents the Kubernetes spoke from processing Kubernetes responses. Set the `com.glide.communications.httpclient.verify_hostname` system property to false to enable the integration.

1. Enter **sys_properties.list** in the application navigator. The System Properties [sys_properties] table opens.
2. Search for the `com.glide.communications.httpclient.verify_hostname` system property.
3. Set the value to false.

*Microsoft AD spoke*

Create, delete, and manage objects in Microsoft Active Directory, such as users, groups, and computers.
IntegrationHub subscription

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Spoke requirements

Ensure that Active Directory Web Services (ADWS) is deployed in the same server where Microsoft AD is installed. See Microsoft documentation for information about deploying ADWS.

In the MID Server and Microsoft AD server, run these PowerShell commands to install the Active Directory module:

```powershell
PS> Import-Module ServerManager
PS> Install-WindowsFeature -Name RSAT-AD-PowerShell
```

Spoke flows

The Microsoft AD spoke provides sample flows in the draft state to demonstrate automating Active Directory tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Offboarding</td>
<td>Disables an AD user account and removes the user from any AD groups when a ServiceNow user record is deactivated.</td>
</tr>
<tr>
<td>User Onboarding</td>
<td>Creates and enables an AD user account when a ServiceNow user record is activated.</td>
</tr>
</tbody>
</table>

Spoke subflows

This spoke has no sample subflows.

Spoke actions

The Microsoft AD spoke provides actions to automate Microsoft Active Directory tasks when events occur in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Delete Computer</td>
<td>Deletes a computer from Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Disable Computer</td>
<td>Disables a computer account in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Enable Computer</td>
<td>Enables a computer account in Active Directory.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Computer OU</td>
<td>Gets the Organizational Unit (OU) of a Computer Account.</td>
</tr>
<tr>
<td></td>
<td>Is Computer Enabled</td>
<td>Checks the status of the specified computer account in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Move Computer to OU</td>
<td>Changes the Organizational Unit (OU) of a Computer Account in Active Directory.</td>
</tr>
<tr>
<td>Group Management</td>
<td>Add User To Group</td>
<td>Adds an existing Active Directory user to an Active Directory group.</td>
</tr>
<tr>
<td></td>
<td>Create Group</td>
<td>Creates a group in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Delete Group</td>
<td>Deletes a group from Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Is User In Group</td>
<td>Checks if an existing Active Directory user is a member of an Active Directory group.</td>
</tr>
<tr>
<td></td>
<td>Lookup Group</td>
<td>Gets the details of a given group in Active Directory, including the group category, scope, and distinguished name.</td>
</tr>
<tr>
<td></td>
<td>Remove User From Group</td>
<td>Removes an existing user from a group in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Change User Password</td>
<td>Changes the user password in AD. The password input must comply with Active Directory password requirements.</td>
</tr>
<tr>
<td>Password Management</td>
<td>Is User Account Locked</td>
<td>Checks the locked status of the specified user account in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Reset AD User Password</td>
<td>Resets a user's password in Active Directory.</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates a user with no password in Active Directory. To enable a user to set a password, log in to AD, create a default password for the user, and enable password reset.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes a user from Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Disable User</td>
<td>Disables a user account in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Enable User</td>
<td>Enables a user account in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Is User Enabled</td>
<td>Checks the status of a user account in Active Directory.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Lookup User</td>
<td>Gets the details of a given user in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Unlock AD Account</td>
<td>Unlocks a user account in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Update User</td>
<td>Updates user attributes in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Update User Home Location</td>
<td>Updates the Home Directory for a User in Active Directory.</td>
</tr>
<tr>
<td>Object Management</td>
<td>Create AD Object</td>
<td>Creates an object of any type supported in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Delete AD Object</td>
<td>Deletes an object of any type from Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Query AD</td>
<td>Queries AD for objects specified by a search filter.</td>
</tr>
<tr>
<td></td>
<td>Update AD Object OU</td>
<td>Changes the Organizational Unit (OU) of an object in Active Directory.</td>
</tr>
<tr>
<td></td>
<td>Update AD Object Expiration</td>
<td>Update the account expiration date of an object in Active Directory.</td>
</tr>
</tbody>
</table>

**MID server requirements**

To use these actions, your instance must have a MID Server set up and configured to use PowerShell. For more information about running actions on the MID Server, see Integration steps. For information, see MID Server.

**Note:** MID and Microsoft AD must be installed on different servers.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection information and OAuth credentials. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you do not need to update any actions that use the connection.

This spoke uses the AD alias record to authorize actions in Microsoft Active Directory.
Set up Microsoft AD spoke

Integrate the ServiceNow instance and your Microsoft AD account using Windows credentials to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Role required: admin

Create Credential record for the Microsoft AD spoke

Create a Credential record for the Microsoft Active Directory host. The Microsoft AD spoke connection and credential alias uses this credential to authorize actions.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
   A blank Windows Credentials form displays.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter AD Credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>User name</td>
<td>Enter a user name with access to the target Windows host. For more information about Windows permissions, see Windows credentials.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for the account.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create Connection record for the Microsoft AD spoke

Create a Connection record to your Microsoft Active Directory host machine. The Microsoft AD spoke connection and credential alias uses this connection to perform actions in Microsoft Active Directory.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for AD.
3. From the Connections tab, click New.
   The system displays a blank Basic Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter AD Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Windows Active Directory. For example, select AD Credential.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Host</td>
<td>Enter the fully qualified domain name of the target host where Microsoft Active Directory is installed. For example, <code>&lt;host&gt;.&lt;domain&gt;.com</code>.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Enable</td>
</tr>
<tr>
<td>Override default port</td>
<td>Enter the target port used by the connection. If blank, the system uses the default port.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Microsoft Azure AD spoke**

Manage users, security groups, and office groups. Apply licenses and provision users in Office 365.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Spoke flows**

The Microsoft Azure AD spoke provides sample flows in the draft state to demonstrate automating Azure Active Directory tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Offboarding</td>
<td>Disables an Azure AD user account and removes the user from any Azure AD groups when a ServiceNow user record is deactivated.</td>
</tr>
<tr>
<td>User Onboarding</td>
<td>Creates and enables an Azure AD user account when a ServiceNow user record is activated.</td>
</tr>
</tbody>
</table>

**Spoke subflows**

The Microsoft Azure AD spoke provides sample subflows in the draft state to demonstrate automating Azure Active Directory tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add User to Group</td>
<td>Looks up the groups that a ServiceNow User record belongs to, and adds the associated Azure AD user account to the same Azure AD groups.</td>
</tr>
</tbody>
</table>
Spoke actions

The Microsoft Azure AD spoke provides actions to automate Azure Active Directory tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Management</td>
<td>Add Owner To Group</td>
<td>Adds an owner to an existing group in Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Add User to Group</td>
<td>Adds an existing user to a group in Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Create Office 365 Group</td>
<td>Creates an Office 365 Group in Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Create Security Group</td>
<td>Create a Security Group in Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Look Up Group ID</td>
<td>Returns the first Group ID found based on provided search criteria.</td>
</tr>
<tr>
<td></td>
<td>Look Up Group Membership</td>
<td>Retrieves a list of groups for the given user as a JSON string.</td>
</tr>
<tr>
<td></td>
<td>Remove Owner From Group</td>
<td>Removes the owner from a group in Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Remove User From Group</td>
<td>Removes an existing user from a group in Azure AD.</td>
</tr>
<tr>
<td>License Management</td>
<td>Assign User License</td>
<td>Assigns a license to an existing user in Azure AD and defines access to Office 365 services. For example, if the license includes access to Microsoft Exchange, the user is provisioned a mailbox and login rights.</td>
</tr>
<tr>
<td></td>
<td>Remove User License</td>
<td>Removes a license from a user in Azure AD.</td>
</tr>
<tr>
<td>Password Management</td>
<td>Reset User Password</td>
<td>Resets the password of the specified Azure AD user account.</td>
</tr>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates an Azure AD user account using the specified account details.</td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes a user from Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Disable User</td>
<td>Disables a user in Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Enable User</td>
<td>Enables a user in Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Is User Enabled</td>
<td>Checks whether the specified user account is enabled in Azure AD.</td>
</tr>
<tr>
<td></td>
<td>Is User In Group</td>
<td>Checks whether the specified user account is a member of the specified group in Azure AD.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look Up User ID</td>
<td>Returns the first User ID found based on the provided search criteria.</td>
</tr>
<tr>
<td></td>
<td>Update User</td>
<td>Updates user properties in Azure AD with the provided details.</td>
</tr>
</tbody>
</table>

**Note:** Azure AD does not allow updating values to null. Null or empty values are discarded in Azure AD when passed as input.

**Microsoft Azure AD account requirements**

The Microsoft Azure AD spoke requires creating a custom app on your Azure AD account to generate OAuth 2.0 tokens. See: Create an Azure AD application.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection information and OAuth credentials. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you do not need to update any actions that use the connection.

This spoke uses the AzureAD alias record to authorize actions on Microsoft Azure AD.

<table>
<thead>
<tr>
<th>Connection alias</th>
<th>Description</th>
<th>Connection URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>AzureAD</td>
<td>Connection to Microsoft Azure AD.</td>
<td><a href="https://graph.microsoft.com">https://graph.microsoft.com</a></td>
</tr>
</tbody>
</table>

**Set up Microsoft Azure AD spoke**

Integrate the ServiceNow instance and your Microsoft Azure AD account by creating a custom OAuth application in Microsoft Azure AD to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Role required: admin

*Create an Azure AD application*  
Create a custom app using your Azure portal to enable OAuth 2.0 authentication with the Azure AD spoke.

- Request IntegrationHub subscription.
- Activate Azure AD spoke.
- Azure AD requirements:
  - Azure AD account
  - Azure AD administrator credentials
- Role required: admin
Complete these steps from your Azure portal. See the Azure Active Directory for developers documentation for instructions on creating and configuring custom applications.

1. From your Azure portal, access Azure Active Directory.
2. Create an Azure AD application.
   a) In Redirect URI, enter your ServiceNow instance URL in this format: https://<Instance-Name>.servicenow.com/oauth_redirect.do. See Create an Azure Active Directory application for instructions on registering and configuring an application.
   b) Record the Directory ID to register the app as a third-party OAuth provider on your ServiceNow instance.
   c) Create a Client Secret and record the value to register the app as a third-party OAuth provider on your ServiceNow instance.
   d) Add permissions to access the APIs. Ensure that you provide these permissions:

<table>
<thead>
<tr>
<th>Permission</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory.AccessAsUser.All</td>
<td>Delegated</td>
</tr>
<tr>
<td>Directory.Read.All</td>
<td>Delegated</td>
</tr>
<tr>
<td>Directory.ReadWrite.All</td>
<td>Delegated</td>
</tr>
<tr>
<td>User.Read</td>
<td>Delegated</td>
</tr>
<tr>
<td>offline_access</td>
<td>Delegated</td>
</tr>
<tr>
<td>Directory.Read.All</td>
<td>Application</td>
</tr>
<tr>
<td>Directory.ReadWrite.All</td>
<td>Application</td>
</tr>
</tbody>
</table>

   See Add permissions to access web APIs for more information.
   e) Grant admin consent to your application. See Understanding API permissions and admin consent UI for more information.

Register Azure AD as OAuth provider

Register Azure AD as OAuth provider
Use the information generated during Azure Active Directory account configuration to register Box as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

1. Navigate to System OAuth > Application Registry.
2. Click New.
   The system displays the message What kind of OAuth application?
3. Select Connect to a third party OAuth Provider.
   The system displays a blank Application Registries form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Azure AD OAuth.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the Client ID you created during the Azure AD application registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Key value you created during the Azure AD application registration.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select Authorization Code.</td>
</tr>
</tbody>
</table>
5. In the **OAuth Entity Scopes** related list, create these entries

<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter a unique name for the record, such as auth code.</td>
<td>Enter offline_access.</td>
</tr>
<tr>
<td>Enter a unique name for the record, such as openid</td>
<td>Enter openid.</td>
</tr>
</tbody>
</table>

6. Right-click the form header, and click **Save**. The system validates the OAuth credentials and populates the **Redirect URL** and the **OAuth Entity Profiles** related list.

7. In the **OAuth Entity Profiles** related list, open the default profile record.

8. Verify that the openid entity scope record created in previous steps appears in the **OAuth Entity Profile Scopes** related list. If it does not appear, add the record.

---

**Create Credential records for the Azure AD spoke**

Create Credential records to the Azure AD custom app registration you created. The Azure AD spoke connection and credential aliases use these credentials to authorize actions.

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**. The system displays the message **What type of Credentials would you like to create?**.
3. Select **OAuth 2.0 Credentials**. The pop-up window displays a blank OAuth 2.0 Credentials form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Azure AD Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom Azure AD application as an OAuth provider. For example, select Azure OAuth default_profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>
5. Click **Submit**.

*Create Connection records for the Azure AD spoke*

Create Connection records to your Azure AD account. The Azure AD spoke connection and credential aliases use these connections to perform actions in Azure AD.

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the **AzureAD** record.
3. Click the **New** button in the **Connections** related list.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Azure AD Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Azure AD. For example, select Azure AD Credentials.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

*Regenerate Azure AD OAuth token*

Regenerate the Azure AD OAuth token when it expires.

1. Navigate to **Connections & Credentials > Credentials**.
2. Select the Azure AD spoke OAuth Credential record. For example, select Azure AD Credentials.
3. From Related Links, click **Get OAuth Token**.

*Microsoft Azure AD spoke action reference*

Manage users, security groups, and office groups. Apply licenses and provision users in Office 365.

The Azure AD spoke is an available integration through IntegrationHub.

This spoke uses the Azure AD Connection & Credential Alias record. To use these actions, you must create a Connection record and a Credential record and associate them with the Azure AD Connection & Credential Alias record. To learn more about connections and credentials, see **Introduction to credentials, connections, and aliases**.

These actions use REST calls, which can run on an instance or MID Server. To determine when to run REST from the instance or a MID Server, see the design considerations in **Integration steps**. To learn more about the MID Server, see **MID Server**.

*Add Owner To Group*

Adds an owner to an existing group in Azure AD.

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>ID of the group to add an owner to. If the Group ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
<tr>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User ID</td>
<td>ID of the user to make owner of the group. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

**Outputs**

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

**Add User To Group**

Adds an existing user to a group in Azure AD.

**Inputs**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>ID of the group to add a user to. If the Group ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
<tr>
<td>User ID</td>
<td>ID of the user to add to the group. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

**Outputs**

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

**Create Office 365 Group**

Creates an Office 365 Group in Azure AD.

**Inputs**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name to display in the address book for the group.</td>
</tr>
<tr>
<td>Group Email Alias</td>
<td>Alias configured for an email account. A single email account can have more than one alias.</td>
</tr>
<tr>
<td>Email Enable</td>
<td>Group email address or distribution list associated with the group. By default set to true.</td>
</tr>
<tr>
<td>Distribution List</td>
<td>Additional information about the group in Azure AD.</td>
</tr>
</tbody>
</table>
Create Security Group

Create a Security Group in Azure AD.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name to display in the address book for the group.</td>
</tr>
<tr>
<td>Group Email Alias</td>
<td>Alias configured for an email account. A single email account can have more than one alias.</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the group in Azure AD.</td>
</tr>
</tbody>
</table>

Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Group ID</td>
<td>ID of group created in Azure AD. Only populated if Status is Success.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

Is User In Group

Check if an existing user is a member of a group in Azure Active Directory (Azure AD).

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>Group ID in which you wish to check the membership of the user.</td>
</tr>
<tr>
<td>User ID</td>
<td>User ID or User Principal Name of the Azure AD user.</td>
</tr>
</tbody>
</table>

Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Will be set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Answer</td>
<td>True if the user is a member of the group. False if the user is not a member of the group. Populated only if Status is Success.</td>
</tr>
</tbody>
</table>
Look Up Group ID

Returns the first Group ID found based on provided search criteria.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Mail ID</td>
<td>Group email address or distribution list associated with the group.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Name to display in the address book for the group.</td>
</tr>
<tr>
<td>Group Email Alias</td>
<td>Alias configured for an email account. A single email account can have more than one alias.</td>
</tr>
</tbody>
</table>

Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Group ID</td>
<td>First group found with matching criteria in Azure AD.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

Look Up Group Membership

Retrieves a list of groups for the given user as a JSON string.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>ID of the users to retrieve the group for. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
<tr>
<td>Groups List</td>
<td>List of groups in JSON format. For example, [{Group ID1, Group Name1}, {Group ID2, Group Name2}]. If the user is not part of any group, an empty string is returned.</td>
</tr>
<tr>
<td>Number of Groups Found</td>
<td>Total number of groups the user is a member of.</td>
</tr>
</tbody>
</table>
Remove Owner From Group

Removes the owner from a group in Azure AD.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>ID of the group to remove the owner from. If the Group ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
<tr>
<td>User ID</td>
<td>ID of the user to remove as owner of the group. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

Remove User From Group

Removes an existing user from a group in Azure AD.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>ID of the group to remove the user from. If the Group ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
<tr>
<td>User ID</td>
<td>ID of the user to remove from the group. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

Assign User License

Assigns a license to an existing user in Azure AD and defines access to Office 365 services. For example, if the license includes access to Microsoft Exchange, the user is provisioned a mailbox and login rights.
Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>ID of the user to assign a license to. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
<tr>
<td>SKU ID</td>
<td>Licensing plan for your organization using the syntax <code>&lt;Company Name&gt;:&lt;Licensing Plan&gt;</code>. If the SKU ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

**Remove User License**

Removes a license from a user in Azure AD.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>ID of the user to remove the license from. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
<tr>
<td>SKU ID</td>
<td>Licensing plan for your organization using the syntax <code>&lt;Company Name&gt;:&lt;Licensing Plan&gt;</code>. If the SKU ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

**Delete User**

Deletes a user from Azure AD.

Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>ID of the user to delete. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>
Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

**Disable User**

Disables a user in Azure AD.

**Inputs**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>ID of the user to disable. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

**Outputs**

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

**Enable User**

 Enables a user in Azure AD.

**Inputs**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>ID of the user to enable. If the User ID does not exist in Azure AD, the Status output is set to Error.</td>
</tr>
</tbody>
</table>

**Outputs**

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

**Look Up User ID**

Returns the first User ID found based on the provided search criteria.
### Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>First name of the user.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Last name of the user.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Name displayed in the address book for the user.</td>
</tr>
<tr>
<td>User Login ID</td>
<td>Login User ID is same as User Principal Name(UPN). For example, <a href="mailto:johndoe@snc.com">johndoe@snc.com</a>.</td>
</tr>
<tr>
<td>Email Alias</td>
<td>Alias configured for an email account. A single email account can have more than one alias.</td>
</tr>
</tbody>
</table>

### Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>User ID</td>
<td>First user found with matching criteria in Azure AD.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

### Update User

Updates user properties in Azure AD with the provided details.

**Note:** Azure AD does not allow updating values to null. Null or empty values are discarded in Azure AD when passed as input.

### Inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name to display in the address book for the user.</td>
</tr>
<tr>
<td>Email Alias</td>
<td>Alias configured for an email account. A single email account can have more than one alias.</td>
</tr>
<tr>
<td>User Login ID</td>
<td>Login User ID is same as User Principal Name(UPN). For example, <a href="mailto:johndoe@snc.com">johndoe@snc.com</a>. This field is mandatory</td>
</tr>
<tr>
<td>First Name</td>
<td>First name of the user.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Last name of the user.</td>
</tr>
<tr>
<td>City</td>
<td>City of the user.</td>
</tr>
<tr>
<td>Country</td>
<td>Country of the user.</td>
</tr>
<tr>
<td>Department</td>
<td>Name of the department the user belongs to.</td>
</tr>
<tr>
<td>Mobile</td>
<td>Mobile phone number for the user.</td>
</tr>
<tr>
<td>Job Title</td>
<td>User job title.</td>
</tr>
<tr>
<td>Physical Delivery Office Name</td>
<td>Office location of the user.</td>
</tr>
</tbody>
</table>
### Input

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Postal Code</td>
<td>Postal code for the user.</td>
</tr>
<tr>
<td>Preferred Language</td>
<td>Preferred language for the user.</td>
</tr>
<tr>
<td>State</td>
<td>State for the user.</td>
</tr>
<tr>
<td>Street Address</td>
<td>Street address for the user.</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>Telephone number for the user.</td>
</tr>
<tr>
<td>Usage Location</td>
<td>Some Microsoft services are not available in all locations. This property must be defined for the user in Azure AD before a license can be assigned to them.</td>
</tr>
</tbody>
</table>

### Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Set to Success if the request succeeds or Error if a failure in Azure AD occurs.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for the error. Populated only when an error occurs.</td>
</tr>
</tbody>
</table>

### Microsoft Dynamics CRM spoke v1.0.1

Provide the baseline actions to interact with Microsoft Dynamic Entities through introspection.

#### IntegrationHub subscription

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

#### Spoke flows & subflows

This spoke ships with one subflow, Process Dynamics CRM Webhook. See Configure Microsoft Dynamics CRM webhook details.

#### Spoke actions

The Microsoft Dynamics CRM spoke provides the baseline actions to interact with Microsoft Dynamic Entities through introspection.

**Available Microsoft Dynamics CRM spoke actions**

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Create Account</td>
<td>Create an account in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Get Account Details</td>
<td>Retrieve the details of the required account in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Case Management</td>
<td>Create Case</td>
<td>Create case in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Get Case Details</td>
<td>Retrieve details of the required case in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td>Contact Management</td>
<td>Create Contact</td>
<td>Create contact in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Get Contact Details</td>
<td>Retrieve details of the required contact in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td>Lead Management</td>
<td>Create Lead</td>
<td>Create lead in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Get Lead Details</td>
<td>Retrieve details of the required lead in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Entities</td>
<td>Retrieve all the entities and their logical names in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Get Entity Metadata</td>
<td>Retrieve all the metadata available for the required entity type in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Get Entity URL</td>
<td>Retrieve all the entities and its entity set name (public URL name) available in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Get Field Choice List</td>
<td>Retrieve all the choice lists for the fields that are in the name and label pair format.</td>
</tr>
<tr>
<td>Opportunity Management</td>
<td>Create Opportunity</td>
<td>Create an opportunity in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Get Opportunity Details</td>
<td>Retrieve the details of the required opportunity in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td>Record Management</td>
<td>Create Record</td>
<td>Create a record in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Delete Record</td>
<td>Deletes a record in Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td></td>
<td>Get Record Details</td>
<td>Retrieve information about the required record in an Entity.</td>
</tr>
<tr>
<td></td>
<td>Get Records</td>
<td>Retrieve all the records for the entity that are provided as name and ID pair.</td>
</tr>
<tr>
<td></td>
<td>Look Up Record</td>
<td>Retrieve record based on the search query and entity selected from the choice list.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Look Up Records</td>
<td>Retrieve records based on the search query and specific entity.</td>
</tr>
<tr>
<td></td>
<td>Update Record</td>
<td>Update a record in Microsoft Dynamics CRM.</td>
</tr>
</tbody>
</table>

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see [Credentials and connection information](#).

This spoke uses the Microsoft_Dynamics_CRM alias record to authorize actions.

<table>
<thead>
<tr>
<th>Connection alias</th>
<th>Description</th>
<th>Connection URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft_Dynamics_CRM</td>
<td>Connection to Microsoft Dynamics CRM</td>
<td>URL configured when you create your application in Azure. This URL ends with dynamics.com.</td>
</tr>
</tbody>
</table>

**Set up Microsoft Dynamics CRM spoke**

Integrate the ServiceNow instance and Microsoft Dynamics CRM by using the Windows credentials to authenticate ServiceNow requests.

- Install Microsoft AD
- Request IntegrationHub subscription.
- Activate the Microsoft Dynamics CRM spoke.
- Role required: admin.

- Perform these steps to use all Microsoft Dynamics CRM spoke actions.

Configure Microsoft Dynamics CRM application

Create a custom OAuth application from your Microsoft Dynamics CRM account to enable OAuth 2.0 authentication with the Microsoft Dynamics CRM.

Microsoft Dynamics CRM requirements:

- Microsoft Dynamics CRM account
- **Microsoft Azure** account
- Microsoft Dynamics CRM credentials

Complete these steps from your Azure Developer account. See the Azure product documentation for instructions on creating and configuring custom applications.

1. Log in to the [Microsoft Azure App registration portal](#) with your organization credentials.
2. Register a new custom application. Fill in the application name, the supported account type, and the redirect URI, and then click **Register**.

   An overview of the application's basic information is shown.
3. Copy the application ID to a text file.

   You will use this ID and the client secret generated in the next step to register the app as a third-party OAuth provider on your ServiceNow instance. You use the application ID as the client ID when you connect the application to ServiceNow.
4. Add a client secret.
   a) In Microsoft Azure, navigate to Manage > Certificates & secrets.
   b) Provide a description and an expiration date and click Add.

   **Note:** The client secret is only displayed in plain text for a short time. You use the client secret when you connect the application to ServiceNow.

5. Enable the permissions you want the application to support. For more information, see the Microsoft Graph permissions reference.
   a) In Microsoft Azure, navigate to Manage > API permissions.
   b) Click the Microsoft Graph tile.
   c) Select the Delegated or Application permissions that the application supports.
      Delegated permissions enable the application to access the API as a signed-in user. Application permissions enable the application to run as a background service or daemon without a signed-in user.
   d) Click Add permissions.

Register Microsoft Dynamics CRM as OAuth provider.

Use the information generated during Microsoft Dynamics CRM account configuration to register Microsoft Dynamics CRM as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

- Request IntegrationHub subscription.
- Activate Microsoft Dynamics CRM.
- Create a Microsoft Dynamics CRM application.

Role required: admin.

1. In ServiceNow, navigate to System OAuth > Application Registry.
2. Click New.
3. On the screen titled What kind of OAuth application, select Connect to a third-party OAuth Provider.
4. Enter these values in the Application Registries form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record, for example Dynamics CRM OAuth profile.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the Application ID of the Microsoft Dynamics CRM application you created in Azure.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret you generated when you created the application in Azure.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select Authorization Code.</td>
</tr>
<tr>
<td>Field</td>
<td>Value required</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>Click the lock icon ( ), enter <a href="https://login.microsoftonline.com/common/oauth2/v2.0/authorize">https://login.microsoftonline.com/common/oauth2/v2.0/authorize</a> followed by a question mark and the resource attribute of your instance, and then click the lock icon again. The resource attribute of the URL. For example, ?resource=<a href="https://mycompany.crm.dynamics.com">https://mycompany.crm.dynamics.com</a>. This attribute is the URL of your Microsoft application.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Click the lock icon ( ), enter <a href="https://login.microsoftonline.com/common/oauth2/v2.0/token">https://login.microsoftonline.com/common/oauth2/v2.0/token</a>, and then click the lock icon again.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>Click the lock icon ( ), enter https://&lt;instance&gt;.service-now.com/oauth_redirect.do, and then click the lock icon again.</td>
</tr>
</tbody>
</table>
5. In the **OAuth Entity Scopes** related list, edit the provided entity scope to include the URL of your Microsoft Dynamics CRM application. The name and the OAuth scope are often the same string.

![OAuth Entity Scopes](image)

6. Right-click the form header, and click **Save**. The system validates the OAuth credentials.

Create credential record for Microsoft Dynamics CRM.

**Create Credential records for the Microsoft Dynamics CRM spoke**

Create Credential records for the Microsoft Dynamics CRM custom OAuth application you created during Microsoft Dynamics CRM account configuration. The Microsoft Dynamics CRM spoke connection and credential aliases use these credentials to authorize actions.

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**. The system displays the message **What type of Credentials would you like to create?**.
3. Select **OAuth 2.0 Credentials**. The pop-up window displays a blank OAuth 2.0 Credentials form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter <strong>Dynamics Credentials</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom Microsoft Dynamics CRM application as an OAuth provider. For example, select <strong>Dynamics OAuth profile</strong>.</td>
</tr>
</tbody>
</table>
Create Connection records for the Microsoft Dynamics CRM spoke
Create Connection records to your Microsoft Azure account. The Microsoft Dynamics CRM spoke connection and credential alias uses these connections to perform actions on Microsoft Dynamics CRM.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the connection and credential alias for the Microsoft Dynamics CRM application.
3. On the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter MS Dynamics CRM Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Microsoft Dynamics CRM. For example, select MS Dynamics Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Select the Connection alias record you created for Microsoft Dynamics CRM.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter the root Dynamics URL. For example, https://&lt;SiteName&gt;.dynamics.com.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Configure Microsoft Dynamics CRM webhook details
Register Microsoft Dynamics CRM webhook in ServiceNow to notify the ServiceNow application when certain events occur in Microsoft Dynamics CRM.

Role required: admin
- Microsoft Dynamics CRM requires registration through the Windows Plugin Registration Tool. To install the Windows Plugin Registration Tool, see the Microsoft document Download tools from NuGet.
- The Endpoint URL is the ServiceNow instance URL to which event information is posted. For example, https://<instance-name>.service-now.com/api/sn_ms_crm_spoke/dynamics_webhook_callbacks.
- The key-value pair you use to register the webhook in the Plugin Registration Tool is the same as the Name and Authorization Key in Dynamics CRM Webhook Details.

1. Navigate to Dynamics CRM Webhook Details > Client Details.
2. Click New.
3. In the **Name** field, enter the webhook's plugin key. In the **Authorization Key** field, enter the value from the webhook's key-value pair.

Configure Microsoft Dynamics CRM webhook decision policy

Create webhook routing policy and subflow according to your requirements.

1. Navigate to Flow Designer > Designer
2. Click **Subflows**.
3. Create a copy of the default subflow, Process Dynamics CRM Webhook.
4. Customize the subflow according to your requirement and publish it. See for more information about creating and using subflows.
5. Navigate to Dynamics CRM Webhook Details > Decision Policy.
6. On the **Decisions** tab, click **New**.
7. On the form, fill in the fields.

### Decision form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique label to identify the routing policy.</td>
</tr>
<tr>
<td>Answer</td>
<td>Option to specify if this answer is the default answer. Default answer is applicable when the conditions are not met.</td>
</tr>
<tr>
<td></td>
<td><strong>a.</strong> Click the Lookup icon.</td>
</tr>
<tr>
<td></td>
<td><strong>b.</strong> Select the required subflow from the Document: list.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions to be met when the required events occur in Microsoft Dynamics CRM.</td>
</tr>
</tbody>
</table>

8. Click **Submit**.

**Note:** These routing policies are saved in the Decision tables. Users are cautioned against directly updating or modifying data in these tables.

Decision policy and subflow are created.

**Microsoft Exchange Online spoke v1.2.0**

The Microsoft Exchange Online spoke creates and manages calendar and mail in Microsoft Exchange Online. To create, manage, or delete users and groups, use the Microsoft Azure AD spoke.

**Note:** User and group management can be done using Microsoft Azure AD only and not Microsoft Exchange Online spoke.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

Supported version

Microsoft Graph REST API v1.0

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)
- Complex Object (com.glide.cobject)
- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)

Note: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

Spoke actions

The Microsoft Exchange Online spoke provides actions to automate calendar and mail tasks when an incident is created in the ServiceNow instance.

Microsoft Exchange Online spoke actions

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar Management</td>
<td>Copy Attachment To Calendar Event</td>
<td>Copies a ServiceNow attachment to an Exchange calendar event.</td>
</tr>
<tr>
<td></td>
<td>Create Calendar Event</td>
<td>Creates an event in the user's default calendar and specifies the time zone for the start and end times of the event.</td>
</tr>
<tr>
<td></td>
<td>Create Recurring Calendar Events</td>
<td>Creates a recurring event in the user's default calendar and specifies the time zone for the start and end times of the event.</td>
</tr>
<tr>
<td></td>
<td>Delete Calendar Event</td>
<td>Deletes a calendar event.</td>
</tr>
</tbody>
</table>
## Microsoft account requirements

The Microsoft Exchange Online spoke requires registering an application using the Microsoft Azure portal to generate OAuth 2.0 tokens.

## Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Credentials and connection information](#).

## Set up Microsoft Exchange Online spoke

Integrate the ServiceNow instance and Microsoft Exchange Online account by creating a custom OAuth application in Microsoft Exchange Online to authenticate ServiceNow requests.

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Get Calendar Events by User ID</td>
<td>Retrieves the list of event objects in the user's mailbox.</td>
</tr>
<tr>
<td></td>
<td>Get Schedule</td>
<td>Retrieves the availability information for a collection of users, distributions lists, or resources (rooms or equipment) within the specified time period.</td>
</tr>
<tr>
<td></td>
<td>Look up Calendar View</td>
<td>Retrieves the list of meeting entries for the specified User ID within the specified time period.</td>
</tr>
<tr>
<td></td>
<td>Update Calendar Event</td>
<td>Updates the properties of an event object.</td>
</tr>
<tr>
<td>Mail Management</td>
<td>Delete Message</td>
<td>Deletes the message in user’s inbox or from a custom folder.</td>
</tr>
<tr>
<td></td>
<td>Look Up Mail Folders By User ID</td>
<td>Retrieves all the mail folders for a specified User ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Messages By Mail Folder ID</td>
<td>Retrieves all the messages in a mail folder.</td>
</tr>
<tr>
<td></td>
<td>Look Up Messages By User ID</td>
<td>Retrieves all the messages in the inbox folder of the user.</td>
</tr>
<tr>
<td></td>
<td>Set Mailbox Auto Reply</td>
<td>Sets the user’s auto-reply message for the given time period.</td>
</tr>
<tr>
<td>Metadata Retrieval</td>
<td>Get Time Zones</td>
<td>Retrieves the list of all available time zones.</td>
</tr>
<tr>
<td></td>
<td>Look Up Rooms</td>
<td>Lists all the rooms defined in the tenant.</td>
</tr>
<tr>
<td></td>
<td>Fetch Rooms</td>
<td>Retrieves details of rooms available in a tenant.</td>
</tr>
</tbody>
</table>
• Request IntegrationHub Professional subscription
• Activate the Microsoft Exchange Online spoke
• Role required: admin

Register an application using the Microsoft Azure portal
Provide authorization to the ServiceNow instance by registering an application with Azure AD.

Role required: Azure Active Directory admin

Complete these steps from the Microsoft Azure portal. For instructions on registering an application, see the Microsoft Azure documentation.

1. In the Microsoft Azure portal, add the Redirect URIs in this format: https://<instance-name>.service-now.com/oauth_redirect.do
2. For the Required Permissions, select Microsoft Graph.
3. Record the Client Secret for use in later configurations.

The ServiceNow application is created with Microsoft Azure AD.

Register Microsoft Exchange Online as the OAuth provider
Register Microsoft Exchange Online as the OAuth provider so that the ServiceNow instance can request OAuth 2.0 tokens.

Use the information generated during the registration of the application in the Microsoft Azure portal.

1. Navigate to System OAuth > Application Registry.
2. Open the record, Microsoft Exchange Online.
3. On the form, fill in the fields.

### Application Registrations form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Microsoft Exchange Online.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Application ID created during application registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client secret created during application registration.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Optional script to customize the request and response.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>URL that contains an image to use as the application logo.</td>
</tr>
<tr>
<td>Default Grant Type</td>
<td>Grant type used to establish the token. Select Authorization Code.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
</tbody>
</table>

**Note:** You can use only Authorization Code as the Default Grant type when PKCE is enabled.

Application Application scope that contains this record.
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint. Enter https://&lt;instance-name&gt;.service-now.com/oauth_redirect.do</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. This option requires a mutual authentication profile to be specified.</td>
</tr>
<tr>
<td>Send Credentials</td>
<td>Client credentials in the request.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**. A system-generated OAuth entity profile is created and displayed in the OAuth Entity Profiles related list. For example, *Microsoft Exchange Online default_profile.*

5. Navigate to **System OAuth > Application Registry**.

6. Open the record, **Microsoft Exchange Online_clientCredentials**.

7. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Application Registries form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>----------------------------</td>
</tr>
<tr>
<td>Client ID</td>
</tr>
<tr>
<td>Client Secret</td>
</tr>
<tr>
<td>Default Grant Type</td>
</tr>
<tr>
<td>Redirect URL</td>
</tr>
</tbody>
</table>

8. Right-click the form header, and click **Save**. A system-generated OAuth entity profile is created and displayed in the OAuth Entity Profiles related list. For example, *Microsoft Exchange Online_clientCredentials default_profile.*

**Create Credential records for the Microsoft Exchange Online spoke**

Authorize the Microsoft Exchange Online spoke actions by creating credential records for the application registered in the Microsoft Azure portal. The Microsoft Exchange Online connection and credential alias uses these credentials to authorize actions.

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   The system displays the message, *What type of Credentials would you like to create?*

3. Select **OAuth 2.0 Credentials**.

4. On the form, fill in the fields.

**OAuth 2.0 Credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Exchange_Online_Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of Microsoft Exchange Online spoke as an OAuth provider with Default Grant Type as Authorization Code. For example, Microsoft Exchange Online.</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the credentials are used. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Save**.

6. To generate the OAuth token, click the **Get OAuth Token** related link.

7. Navigate to **Connections & Credentials > Credentials**.

8. Click **New**.
   The system displays the message, *What type of Credentials would you like to create?*

9. Select **OAuth 2.0 Credentials**.

10. On the form, fill in the fields.

**OAuth 2.0 Credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Exchange_Online_Credentials_clientCred.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of Microsoft Exchange Online spoke as an OAuth provider with Default Grant Type as Client Credentials. For example, Microsoft Exchange Online_clientCredentials_default_profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the credentials are used. For example, enter 100.</td>
</tr>
</tbody>
</table>

11. Right-click the form header and click **Save**.
12. To generate the OAuth token, click the **Get OAuth Token** related link.

The credential records for the Microsoft Exchange Online spoke are created.

*Create Connection records for the Microsoft Exchange Online spoke*

Perform actions in Microsoft Exchange Online by creating connection records for your Microsoft Exchange Online account. The Microsoft Exchange Online spoke connection and credential alias uses these connections to perform actions.

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the record, **Microsoft_Exchange_Online**.
3. In the Connections related list, click **New**.
4. On the form, fill in the fields.

**HTTP(s) Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Exchange_Online_Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Microsoft Exchange Online. For example, Exchange_Online_Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Note: Do not select the check box.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. Click **Update**.
6. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
7. Open the record, **Microsoft_Exchange_Online_clientCred**.
8. In the Connections related list, click **New**.

**HTTP(s) Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Exchange_Online_Connection_clientCred.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Microsoft Exchange Online. For example, Exchange_Online_Credentials_clientCred.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>URL builder</td>
<td><strong>Note:</strong> Do not select the check box.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

10. Click **Update**.

The Microsoft Exchange Online spoke is set up and integrated with the ServiceNow instance.

**Regenerate the Microsoft Exchange Online OAuth token**

Authorize the Microsoft Exchange Online spoke by regenerating the Microsoft Exchange Online OAuth token after it expires.

Role required: admin

1. Navigate to **Connections & Credentials > Credentials**.
2. Select the Microsoft Exchange Online spoke OAuth Credential record.
3. To regenerate the OAuth token, click the **Get OAuth Token** related link.

The Microsoft Exchange Online spoke receives a new OAuth access token.

**Microsoft Exchange Server spoke v1.7**

The Microsoft Exchange Server spoke creates and manages address list, mailbox, and calendar events in Microsoft Exchange mail system.

The Microsoft Exchange Server spoke requires an IntegrationHub subscription.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:
- ServiceNow IntegrationHub Action Step - PowerShell (com.glide.hub.action_step.powershell)
• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

i **Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

**Supported versions**

• Exchange Server 2016 installed on Windows Server 2016

i **Note:** The Create Calendar Event For User and Lookup Room Availability actions are supported only on Exchange Server 2013.

• Exchange Server 2013 installed on Windows Server 2012 R2

This spoke may be compatible with the earlier versions of Microsoft Exchange Server.

**Spoke requirements**

Powershell remoting must be enabled on the target Exchange Server.

**Spoke actions**

The Microsoft Exchange Server spoke provides actions to automate address list, mailbox, and calendar event tasks.

**Microsoft Exchange Server spoke actions**

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address List Management</td>
<td>Create Address List Using Included Recipients</td>
<td>Creates a new address list in Exchange Server using the Included Recipients field.</td>
</tr>
<tr>
<td></td>
<td>Create Address List Using Recipient Filter</td>
<td>Creates a new address list in Exchange Server using the Recipient field.</td>
</tr>
<tr>
<td></td>
<td>Delete Address List</td>
<td>Deletes the required address list on a required Exchange Server.</td>
</tr>
<tr>
<td></td>
<td>Get Address List Details</td>
<td>Retrieves the details of a required address list on a required Exchange Server.</td>
</tr>
<tr>
<td></td>
<td>Look Up Address List</td>
<td>Retrieves the address list details on a required Exchange Server using a search query.</td>
</tr>
<tr>
<td></td>
<td>Move Address List</td>
<td>Moves an address list to another location in the address hierarchy.</td>
</tr>
<tr>
<td></td>
<td>Synchronize Address List</td>
<td>Refreshes email clients with the latest details, for a required address list in Exchange Server.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Update Address List Using Included Recipients</td>
<td>Updates details and recipients of a required address list using a the <em>Included Recipients</em> field.</td>
</tr>
<tr>
<td></td>
<td>Update Address List Using Recipient Filter</td>
<td>Updates details and recipients of a required address list details using the <em>Recipient Filter</em> field.</td>
</tr>
<tr>
<td>Mailbox Management</td>
<td>Create Calendar Event For User</td>
<td>Creates a calendar event in Exchange Server. Calendar event can be either a meeting or appointment.</td>
</tr>
<tr>
<td></td>
<td>Create Mailbox</td>
<td>Creates mailboxes and user accounts simultaneously.</td>
</tr>
<tr>
<td></td>
<td>Delete Mailbox</td>
<td>Deletes a mailbox in Exchange Server.</td>
</tr>
<tr>
<td></td>
<td>Disable Mailbox</td>
<td>Disables a mailbox in Exchange Server.</td>
</tr>
<tr>
<td></td>
<td>Enable Mailbox</td>
<td>Enables a mailbox in Exchange Server.</td>
</tr>
<tr>
<td></td>
<td>Get Mailbox</td>
<td>Retrieves the properties of a mailbox in Exchange Server.</td>
</tr>
<tr>
<td></td>
<td>Set Mailbox</td>
<td>Modifies the properties of a mailbox in Exchange Server.</td>
</tr>
<tr>
<td></td>
<td>Update Mailbox</td>
<td>Updates the properties of a mailbox in Exchange Server.</td>
</tr>
<tr>
<td></td>
<td>Lookup Room Availability</td>
<td>Retrieves the availability response for a given array of room objects.</td>
</tr>
<tr>
<td></td>
<td>Set Mailbox Auto Reply</td>
<td>Schedules the auto-reply for a given mailbox in Exchange Server.</td>
</tr>
<tr>
<td></td>
<td>Lookup Room Mailboxes</td>
<td>Retrieves all the room mailboxes in Exchange Server.</td>
</tr>
<tr>
<td>Meeting Management</td>
<td>Get Meeting Suggestions</td>
<td>Retrieves the meeting suggestions for the specified mailboxes.</td>
</tr>
</tbody>
</table>

*Note:*
- This action is supported only on Exchange Server 2013.
- This action uses the Exchange_https connection and credential alias.
Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Credentials and connection information.

Two connection and credential aliases are created when the Microsoft Exchange Server spoke is activated, Exchange and Exchange_https.

Note:
- The Exchange_https alias is supported only on Exchange Server 2013.
- The Exchange_https alias is required to use the Create Calendar Event For User and Lookup Room Availability actions.

MID Server requirements

Your instance must have a MID Server set up and configured to run PowerShell 2.0. Use the connection record associated with the Microsoft Exchange alias to configure where actions run as well as set MID server selection attributes. For more information, see MID server.

Set up Microsoft Exchange Server spoke

Integrate the ServiceNow instance and Exchange Server by using the Windows credentials to authenticate ServiceNow requests.

• Request IntegrationHub subscription
• Activate the Microsoft Exchange Server spoke
• Role required: admin

• Perform these steps to use all Microsoft Exchange Server spoke actions except the Create Calendar Event For User and Lookup Room Availability actions.
• To use the Create Calendar Event For User and Lookup Room Availability actions, perform the same steps again for the Exchange_https connection and credential alias. MID Server is not necessary to perform this action.

Note:
- The Create Calendar Event For User and Lookup Room Availability actions are supported only on Exchange Server 2013.
- Ensure that the user details provided in the credential record, has the application impersonation role.

Create Credential record for Microsoft Exchange Server spoke

Authorize the Microsoft Exchange Server spoke actions by creating Windows credential record for the Exchange Server host. The Microsoft Exchange Server spoke connection and credential alias uses these credentials to authorize actions.

Create two credential records, one for each connection and credential alias.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
The system displays the message, \textit{What type of Credentials would you like to create?}

3. Select \textbf{Windows Credentials}.

4. On the form, fill in the fields.

\textbf{Windows Credentials form}

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, MSExchangeCredentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>User name</td>
<td>User name with access to the target Windows host. For more information about Windows permissions, see Windows credentials.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for the account.</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential. For example, select \textit{All MID Servers}.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the credentials are used. For example, enter 100.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Advanced selection criteria for the credential.</td>
</tr>
</tbody>
</table>

5. Click \textbf{Submit}.

The Windows credential record for the Microsoft Exchange Server spoke is created. 

\textit{Create Connection record for Microsoft Exchange Server spoke}

Perform actions in Microsoft Exchange Server spoke by creating connection records. The Microsoft Exchange Server spoke connection and credential alias uses these connections to perform actions.

1. Navigate to \textbf{Connections & Credentials > Connection & Credential Aliases}.

2. Open the Microsoft Exchange Server spoke record.

3. In the Connections related list, click \textbf{New}.

4. On the form, fill in the fields.

\textbf{Connection form}

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Exchange Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for the Microsoft Exchange Server spoke. For example, MSExchangeCredentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>Host</td>
<td>Fully qualified domain name or IP address of the target host where Exchange Server is installed.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
<tr>
<td>Override default port</td>
<td>Target port that the connection uses.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
</tbody>
</table>

**Note:** MID Server is necessary for all the Microsoft Exchange Server spoke actions except the Create Calendar Event For User action.

5. Click **Submit**.

The Microsoft Exchange Server spoke is set up and integrated with the ServiceNow instance.

**Microsoft OneDrive spoke v1.5.2**

Automate file and folder management and collaboration in Microsoft OneDrive. Adds Microsoft OneDrive data to your ServiceNow instance.

**Request apps on the Store**

Visit the [ServiceNow Store](#) website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the [ServiceNow Store version history release notes](#).

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see [Request IntegrationHub](#).

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

**Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

**Supported versions**

API version v1.
Spoke subflows

The Microsoft OneDrive spoke provides sample subflows in the draft state to demonstrate automating Microsoft OneDrive tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move a ServiceNow attachment to OneDrive</td>
<td>Copies an attachment from ServiceNow to OneDrive, records the new location of the attachment, and deletes the attachment from the ServiceNow attachment table.</td>
</tr>
</tbody>
</table>

Spoke actions

The Microsoft OneDrive spoke provides actions to automate Microsoft OneDrive tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive Management</td>
<td>Get Drive Info</td>
<td>Gets the metadata of a specific Microsoft OneDrive drive</td>
</tr>
<tr>
<td></td>
<td>List Drives</td>
<td>Retrieves all the available drives associated with a target User, Group, or Site. If you don't provide a User, Group, or Site, then a list of root drives associated with the authenticated user is returned.</td>
</tr>
<tr>
<td>Folder Management</td>
<td>Move File Or Folder Item</td>
<td>Moves a file or folder in Microsoft OneDrive to the target location.</td>
</tr>
<tr>
<td></td>
<td>Create Folder</td>
<td>Creates a folder in Microsoft OneDrive.</td>
</tr>
<tr>
<td></td>
<td>Update File Or Folder Name</td>
<td>Updates the name for a file or folder item by ID.</td>
</tr>
<tr>
<td></td>
<td>Delete File Or Folder Item</td>
<td>Deletes a file or folder from Microsoft OneDrive.</td>
</tr>
<tr>
<td>File Management</td>
<td>Copy OneDrive File to Attachment</td>
<td>Copies a file in Microsoft OneDrive to an attachment in a record in a ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Copy Attachment to OneDrive</td>
<td>Copies an attachment record in ServiceNow to Microsoft OneDrive</td>
</tr>
<tr>
<td></td>
<td>Copy File Or Folder Item</td>
<td>Asynchronously creates a copy of a Microsoft OneDrive item (including children), under a new parent item or with a new name.</td>
</tr>
<tr>
<td></td>
<td>List Items</td>
<td>Retrieves a list of drive items from either a path or the source and source ID of a drive item.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get File Or Folder Item Info By ID</td>
<td>Gets file metadata information from the file or folder ID in Microsoft OneDrive.</td>
</tr>
<tr>
<td></td>
<td>Get File Or Folder Item Info By Path</td>
<td>Gets file metadata information from the file path in Microsoft OneDrive.</td>
</tr>
<tr>
<td></td>
<td>Copy Attachment To OneDrive Using Path</td>
<td>Copies an attachment record in ServiceNow to OneDrive.</td>
</tr>
<tr>
<td></td>
<td>Copy OneDrive File To Attachment Using File Path</td>
<td>Copies a file using its path in OneDrive to an attachment in a record in ServiceNow.</td>
</tr>
<tr>
<td></td>
<td>Copy OneDrive File Version To Attachment</td>
<td>Copies a file in OneDrive to an attachment in a record in ServiceNow.</td>
</tr>
<tr>
<td></td>
<td>Delete Version of a File</td>
<td>Deletes the specified version of a file from OneDrive.</td>
</tr>
<tr>
<td></td>
<td>Get All Versions of A File</td>
<td>Retrieves all the versions a file in OneDrive.</td>
</tr>
<tr>
<td></td>
<td>Restore File Version</td>
<td>Restores the specified file version and make this version the latest.</td>
</tr>
<tr>
<td>Search Documents</td>
<td>Search Files or Folder Items</td>
<td>Searches the drive items (files or folders) based on metadata attributes such as the item name.</td>
</tr>
<tr>
<td>Document Sharing</td>
<td>Add Collaborator</td>
<td>Adds a collaborator and their permissions to a file or a folder. You can identify the collaborator by their Azure AD Alias or an Object ID.</td>
</tr>
<tr>
<td></td>
<td>Get Collaborators</td>
<td>Lists all the collaborator details associated with a file or folder in Microsoft OneDrive.</td>
</tr>
<tr>
<td></td>
<td>Remove Collaborator</td>
<td>Removes a collaborator from a file or folder in Microsoft OneDrive.</td>
</tr>
</tbody>
</table>

**OneDrive Online account requirements**

The Microsoft OneDrive spoke requires a custom app that you create in Microsoft Azure.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple
environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Credentials and connection information.

**Single tenant**

The OneDrive spoke includes the OneDrive alias record to authorize actions on Microsoft OneDrive. Select this alias in the Tenant record to authorize changes in Microsoft OneDrive for a single tenant.

**Multiple tenants**

The OneDrive spoke includes the OneDrive alias record to authorize actions on Microsoft OneDrive. Create a connection and credential alias record for each additional tenant site you wish to support. Select the correct alias in the Tenant record to authorize changes in Microsoft SharePoint. See Create aliases for multiple tenants.

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the MicrosoftSharepointOnline alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Microsoft SCCM spoke**

Automate management of user collections, device collections, and application deployments on a Microsoft System Center Configuration Management (SCCM) server.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Enterprise subscription package. For more information, see Request IntegrationHub.

**Spoke flows & subflows**

This spoke has no sample flows or subflows.

**Spoke actions**

The Microsoft System Center Configuration Management (SCCM) spoke provides actions to automate SCCM tasks when events occur in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Management</td>
<td>Get Applications</td>
<td>Retrieves the application data from the SCCM server.</td>
</tr>
<tr>
<td>Deployment Management</td>
<td>Get Deployments</td>
<td>Retrieves deployment data from the SCCM server.</td>
</tr>
<tr>
<td>Device Management</td>
<td>Add to Device Collection</td>
<td>Adds a device to a collection in SCCM.</td>
</tr>
<tr>
<td></td>
<td>Get Device Collections</td>
<td>Retrieves device collection data from the SCCM server.</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion: Now Platform capabilities

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Is Device In Collection</td>
<td>Checks if a specified device exists in a device collection.</td>
</tr>
<tr>
<td></td>
<td>Remove From Device Collection</td>
<td>Removes a device from an existing device collection.</td>
</tr>
<tr>
<td>User Management</td>
<td>Add to User Collection</td>
<td>Adds a user to a collection in SCCM.</td>
</tr>
<tr>
<td></td>
<td>Get User Collections</td>
<td>Retrieves user collection data from the SCCM Server.</td>
</tr>
<tr>
<td></td>
<td>Is User In Collection</td>
<td>Checks if a specified user exists in a user collection.</td>
</tr>
<tr>
<td></td>
<td>Remove From User Collection</td>
<td>Removes a user from a user collection.</td>
</tr>
</tbody>
</table>

To see inputs and outputs for these activities, see [SCCM activity pack](#).

### MID server requirements

To use these actions, your instance must have a MID Server set up and configured to use PowerShell. For more information about running actions on the MID Server, see Integration steps. For more information, see MID server.

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection information and OAuth credentials. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you do not need to update any actions that use the connection.

This spoke uses the SCCM alias record to authorize actions on a Microsoft System Center Configuration Management (SCCM) server.

<table>
<thead>
<tr>
<th>Connection alias</th>
<th>Description</th>
<th>Connection URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCCM</td>
<td>Connection to the SCCM server.</td>
<td>The URL of the host machine where the SCCM server is installed.</td>
</tr>
</tbody>
</table>

### Set up SCCM spoke

Integrate the ServiceNow instance and SCCM using Windows credentials to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Role required: admin
- Configure the MID Server for SCCM activities

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Create Credential record for the SCCM spoke
Create a Credential record to the SCCM server. The SCCM spoke connection and credential alias uses this credential to authorize actions.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message *What type of Credentials would you like to create?*
   A blank Windows Credentials form displays.
4. Enter these values, then click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter SCCM Credential.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>User name</td>
<td>Enter a user name with access to the target Windows host. For more information about Windows permissions, see Windows credentials.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for the account.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

Create Connection record for the SCCM spoke
Create a Connection record to your SCCM host machine. The SCCM spoke connection and credential alias uses this connection to perform actions in SCCM.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for SCCM.
3. From the Connections tab, click New.
   The system displays a blank Basic Connection form.
4. Enter these values, then click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter SCCM Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Windows. For example, select SCCM Credential.</td>
</tr>
<tr>
<td>Host</td>
<td>Enter the fully qualified domain name of the target host where the SCCM server is installed. For example, &lt;host&gt;.&lt;domain&gt;.com.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Enable</td>
</tr>
<tr>
<td>Override default port</td>
<td>Enter the target port used by the connection. If blank, the system uses the default port.</td>
</tr>
</tbody>
</table>

Configure MID Server as WinRM trusted host
**Microsoft SharePoint spoke v1.1.2**

Manages sites, folders, files, groups, lists, and users in Microsoft SharePoint. Adds Microsoft SharePoint data to your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

**Note:** Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

**Supported versions**

API version v1.

**Spoke flows**

The Microsoft SharePoint spoke provides sample flows in the draft state to demonstrate automating Microsoft SharePoint tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Attachment on Record creates folder, and copies attachment</td>
<td>Creates a Microsoft SharePoint folder with an attachment when the attachment is added to a Knowledge article in ServiceNow.</td>
</tr>
<tr>
<td>Create Site For Knowledge Base</td>
<td>Creates a Microsoft SharePoint site when a Knowledge Base is created in ServiceNow.</td>
</tr>
</tbody>
</table>
Spoke subflows

The Microsoft SharePoint spoke provides sample subflows in the draft state to demonstrate automating Microsoft SharePoint tasks. To customize a sample subflow, copy it to a new application scope. Available sample subflows include:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove Then Add A User To A Group</td>
<td>Removes a previous owner from a Microsoft SharePoint group and adds the new owner.</td>
</tr>
</tbody>
</table>

Spoke actions

The Microsoft SharePoint spoke provides actions to automate Microsoft SharePoint tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Management</td>
<td>Create Site</td>
<td>Creates a site or subsite in Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Delete Site</td>
<td>Removes a site or subsite from Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Look Up Site Collection ID</td>
<td>Looks up a specific site ID.</td>
</tr>
<tr>
<td></td>
<td>Look Up Sites</td>
<td>Looks up the sites in a given Microsoft SharePoint site.</td>
</tr>
<tr>
<td></td>
<td>Look Up Subsite Details</td>
<td>Looks up information about a subsite.</td>
</tr>
<tr>
<td></td>
<td>Update Site Information</td>
<td>Updates a Microsoft SharePoint site.</td>
</tr>
<tr>
<td>Folder Management</td>
<td>Create Folder</td>
<td>Creates a folder in a document library on a Microsoft SharePoint site.</td>
</tr>
<tr>
<td></td>
<td>Delete Folder</td>
<td>Deletes a folder in Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>List Files In A Folder</td>
<td>Gets a list of files in a folder.</td>
</tr>
<tr>
<td></td>
<td>List Folders In A Folder</td>
<td>Gets a list of folders in a folder.</td>
</tr>
<tr>
<td></td>
<td>Look Up Folder</td>
<td>Looks up a folder in Microsoft SharePoint and returns folder properties. For example, use this action to return the relative URL to enter as input in the <strong>Rename A Folder</strong> action.</td>
</tr>
<tr>
<td></td>
<td>Rename A Folder</td>
<td>Renames a folder in Microsoft SharePoint.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Share Folder</td>
<td>Share Folder With Group</td>
<td>Shares a folder with a group in Microsoft SharePoint. The group must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td></td>
<td>Share Folder With User</td>
<td>Shares a folder with a user in Microsoft SharePoint. The user must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td></td>
<td>Unshare Folder With Group</td>
<td>Unshares a folder with a group. The group must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td></td>
<td>Unshare Folder With User</td>
<td>Unshares a folder with a user. The user must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td>File Management</td>
<td>Attach Sharepoint File To A Record</td>
<td>Attaches a Microsoft SharePoint file to a ServiceNow record.</td>
</tr>
<tr>
<td></td>
<td>Check-in File</td>
<td>Checks in a file to Microsoft SharePoint using the Application Service user.</td>
</tr>
<tr>
<td></td>
<td>Check-out File</td>
<td>Checks a file out of Microsoft SharePoint using the Application Service user.</td>
</tr>
<tr>
<td></td>
<td>Copy Attachment To Folder</td>
<td>Copies a ServiceNow attachment to a Microsoft SharePoint folder.</td>
</tr>
<tr>
<td></td>
<td>Copy File</td>
<td>Copies a file with a new name.</td>
</tr>
<tr>
<td></td>
<td>Create A Text File</td>
<td>Uploads a text file to Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Delete File</td>
<td>Deletes a file in Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Look Up File Details</td>
<td>Looks up file details in Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Move File</td>
<td>Moves a file to another location in Microsoft SharePoint.</td>
</tr>
<tr>
<td></td>
<td>Share File With Group</td>
<td>Shares a file with a group in Microsoft SharePoint. The group must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td></td>
<td>Share File With User</td>
<td>Shares a file with a Microsoft SharePoint user. The user must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unshare File With Group</td>
<td>Unshare File With Group</td>
<td>Unshares a file with a Microsoft SharePoint group. The group must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td>Unshare File With User</td>
<td>Unshare File With User</td>
<td>Unshares a file with a Microsoft SharePoint user. The user must belong to the Microsoft SharePoint tenant account.</td>
</tr>
<tr>
<td>Look Up User Information By Login Name</td>
<td>Look Up User Information By Login Name</td>
<td>Searches the Microsoft SharePoint site for a given user and returns information about the user account.</td>
</tr>
<tr>
<td>Look Up User’s SharePoint Groups</td>
<td>Look Up User’s SharePoint Groups</td>
<td>Searches the Microsoft SharePoint site for a given user and returns the user’s Microsoft SharePoint groups regardless of which site or subsite the group is a part of.</td>
</tr>
<tr>
<td>Add Role To Site</td>
<td>Add Role To Site</td>
<td>Adds a role to a Microsoft SharePoint site.</td>
</tr>
<tr>
<td>Add User To Group</td>
<td>Add User To Group</td>
<td>Adds a User to a Microsoft SharePoint site group.</td>
</tr>
<tr>
<td>Create Group</td>
<td>Create Group</td>
<td>Creates a group in a Microsoft SharePoint site.</td>
</tr>
<tr>
<td>Delete Group</td>
<td>Delete Group</td>
<td>Deletes a group on a Microsoft SharePoint site.</td>
</tr>
<tr>
<td>Look Up Group By Name</td>
<td>Look Up Group By Name</td>
<td>Looks up a group by name in the specified site location. If no site location is specified, the spoke searches the tenant root site.</td>
</tr>
<tr>
<td>Remove Role From Site</td>
<td>Remove Role From Site</td>
<td>Removes permissions from a group or user.</td>
</tr>
<tr>
<td>Remove User From Group</td>
<td>Remove User From Group</td>
<td>Removes a user from a Microsoft SharePoint site group.</td>
</tr>
<tr>
<td>Update Group Owner (User)</td>
<td>Update Group Owner (User)</td>
<td>Updates a group owner.</td>
</tr>
<tr>
<td>Create List</td>
<td>Create List</td>
<td>Creates a list in a Microsoft SharePoint site.</td>
</tr>
<tr>
<td>Delete List By ID</td>
<td>Delete List By ID</td>
<td>Deletes a list in a Microsoft SharePoint site.</td>
</tr>
<tr>
<td>Look Up List Details By ID</td>
<td>Look Up List Details By ID</td>
<td>Looks up a list in a Microsoft SharePoint site by ID.</td>
</tr>
<tr>
<td>Look Up List ID By Title</td>
<td>Look Up List ID By Title</td>
<td>Looks up a list in a Microsoft SharePoint site by title.</td>
</tr>
<tr>
<td>Update List Details</td>
<td>Update List Details</td>
<td>Updates a list in a Microsoft SharePoint site.</td>
</tr>
<tr>
<td>Create List Item</td>
<td>Create List Item</td>
<td>Creates a list item inside a list.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delete List Item By ID</td>
<td>Deletes a list item.</td>
</tr>
<tr>
<td></td>
<td>Look Up List Item By ID</td>
<td>Looks up a list item.</td>
</tr>
<tr>
<td></td>
<td>Look Up List Items In A List</td>
<td>Looks up items in a specified list in various useful formats.</td>
</tr>
<tr>
<td></td>
<td>Update List Item By ID</td>
<td>Updates a list item title with the ID.</td>
</tr>
</tbody>
</table>

**Sharepoint Online account requirements**

The Microsoft SharePoint spoke requires creating a custom app on your SharePoint Online account to generate OAuth 2.0 tokens. See [Configure Microsoft SharePoint account](#).

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see [Credentials and connection information](#).

**Single tenant**

This spoke includes the MicrosoftSharepointOnline alias record to authorize actions on Microsoft SharePoint Online. Select this alias in the Tenant record to authorize changes in Microsoft SharePoint for a single tenant.

**Multiple tenants**

This spoke includes the MicrosoftSharepointOnline alias record to authorize actions on Microsoft SharePoint Online. Create a connection and credential alias record for each additional tenant site you wish to support. Select the correct alias in the Tenant record to authorize changes in Microsoft SharePoint. See [Create aliases for multiple tenants](#).

**MID Server requirements**

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the MicrosoftSharepointOnline alias to configure where actions run as well as set MID Server selection attributes. For more information, see [MID server](#).

**Set up Microsoft SharePoint spoke**

Integrate the ServiceNow instance and Microsoft SharePoint by creating a custom OAuth application in Microsoft SharePoint to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Activate Microsoft SharePoint spoke
- Role required: admin

**Configure Microsoft SharePoint account**

Create a custom OAuth application from your Microsoft SharePoint account to enable OAuth 2.0 authentication with the Microsoft SharePoint spoke.

Microsoft SharePoint requirements:
• Microsoft SharePoint Online account and Microsoft SharePoint Onprem account
• Microsoft SharePoint tenant administrator credentials

Complete these steps from your Microsoft SharePoint account. See the SharePoint development documentation for instructions on creating and configuring custom applications.

1. Select Microsoft SharePoint Online account or Microsoft SharePoint Onprem account.
   • For SharePoint Online account, work with your Azure AD administrator to retrieve the Directory ID for the Azure AD Directory that is supporting the Microsoft SharePoint tenant you want to connect to. Record the Directory ID to use as the Tenant ID when creating a Tenant record in your ServiceNow instance.
   • For SharePoint Onprem account, download and run the Hybrid Configuration wizard from the Admin Center. For more information, see Hybrid Configuration wizard.

2. In your SharePoint site, create a custom application.
3. Record the application client ID and client secret to register the app as a third-party OAuth provider on your ServiceNow instance.
4. Enable the matching SharePoint application scope permissions you want the app to support.
   For example, to provide full control, enter the following XML.

```xml
<AppPermissionRequests AllowAppOnlyPolicy="true">
  <AppPermissionRequest
    Scope="http://sharepoint/content/tenant"
    Right="FullControl" />
</AppPermissionRequests>
```

Create aliases for multiple tenants
Create a connection and credential alias record for each additional tenant site you wish to support. Select the correct alias in the Tenant record to authorize changes in Microsoft SharePoint. If configuring an integration for a single tenant, use the existing MicrosoftSharepointOnline alias record.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Click New.
   A blank Connection & Credential Alias record opens
3. On the Connection & Credential Aliases form, fill the following values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>&lt;unique-name&gt;</td>
</tr>
<tr>
<td>Type</td>
<td>Connection and Credential</td>
</tr>
<tr>
<td>Connection type</td>
<td>HTTP</td>
</tr>
</tbody>
</table>

4. Click Submit.

Associate a Credential record and a Connection record with the alias to authorize actions on the SharePoint tenant site. Create an alias record and associated connection and credential records for each tenant you want to support.

Define Microsoft SharePoint tenants
Define a profile for your Microsoft SharePoint tenant site. The Microsoft SharePoint spoke uses the tenant record and associated Connection and Credential alias to perform actions on Microsoft SharePoint.

1. Navigate to SharePoint Online > Tenants.
2. Click New.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the tenant.</td>
</tr>
<tr>
<td>Alias</td>
<td>Select a connection and credential alias. If configuring the integration for a single tenant, select the MicrosoftSharepointOnline alias. If configuring the integration for multiple tenants, select the desired alias.</td>
</tr>
<tr>
<td>Sharepoint Root URL</td>
<td>Enter the root SharePoint URL without the https:// prefix. For example, &lt;SiteName&gt;.sharepoint.com</td>
</tr>
<tr>
<td>Tenant Id</td>
<td>Enter the Tenant ID. This is the Directory ID for the Azure AD Directory that is supporting the Microsoft SharePoint tenant you want to connect to. See Configure Microsoft SharePoint account.</td>
</tr>
<tr>
<td>Resource Id</td>
<td>Auto-populated with 00000003-0000-0ff1-ce00-000000000000.</td>
</tr>
</tbody>
</table>

4. Click Submit.

If configuring an integration with multiple Microsoft SharePoint tenants, create additional tenant profiles as needed.

**Register Microsoft SharePoint as OAuth provider**

Use the information generated during Microsoft SharePoint account configuration to register Microsoft SharePoint as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

1. Navigate to System OAuth > Application Registry.
2. Click New. The system displays the message What kind of OAuth application?
3. Select Connect to a third party OAuth Provider. The system displays a blank Application Registries form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter SharePoint OAuth profile.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the value, &lt;ClientID&gt;@&lt;TenantID&gt;.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret you created during the Microsoft SharePoint account configuration.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Select OAuthUtilSPOnline.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select Client Credentials.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>Enter https:// accounts.accesscontrol.windows.net/ &lt;TenantID&gt;/tokens/OAuth/2. Replace &lt;TenantID&gt; with your Tenant ID.</td>
</tr>
</tbody>
</table>

5. Right-click the form header, and click Save. The system validates the OAuth credentials and populates the Redirect URL and the OAuth Entity Profiles related list.
6. Copy the value from Redirect URL.
7. Login to your Microsoft SharePoint account to edit the configuration of your custom SharePoint application.
   See the SharePoint development site for instructions.
8. Paste the Redirect URL value into the OAuth 2.0 Redirect URI for your custom Microsoft SharePoint application.
   For example, paste https://instance.service-now.com/oauth_redirect.do.

The instance can request OAuth 2.0 tokens for the spoke.

Create Credential records for the Microsoft SharePoint spoke
Create Credential records to the Microsoft SharePoint custom OAuth application you created during Microsoft SharePoint account configuration. The Microsoft SharePoint spoke connection and credential aliases use these credentials to authorize actions.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select OAuth 2.0 Credentials.
   The pop-up window displays a blank OAuth 2.0 Credentials form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter SharePoint Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom Microsoft SharePoint application as an OAuth provider. For example, select SharePoint OAuth profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Save the record.
6. From Related Links, click Get OAuth Token.
   The system displays a confirmation message that the OAuth token flow is completed successfully.
   Review the details if the flow is not completed successfully.

**Note:** Ensure that you allow pop-up windows in your browser.

Create Connection records for the Microsoft SharePoint spoke
Create Connection records to your Microsoft SharePoint account. The Microsoft SharePoint spoke connection and credential alias uses these connections to perform actions on Microsoft SharePoint.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the connection and credential alias used in the Tenant record. See Define Microsoft SharePoint tenants and Create aliases for multiple tenants.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter SharePoint Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Microsoft SharePoint. For example, select SharePoint Credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Select the Connection alias record you created for Microsoft SharePoint.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter the root SharePoint URL. For example, https://&lt;SiteName&gt;.sharepoint.com.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Microsoft Teams spoke

The Microsoft Teams spoke provides actions which post messages and ServiceNow incident, problem, and change record details to Microsoft Teams channels.

IntegrationHub subscription

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Microsoft Teams actions

The Microsoft Teams spoke is an available integration through IntegrationHub. You can specify the following Microsoft Teams actions within a flow:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post a Message</td>
<td>Send a message to a Microsoft Teams channel using a Webhook Connector. Specify the Webhook URL, Title, and Message to send.</td>
</tr>
<tr>
<td>Post Change Details</td>
<td>Send details about a ServiceNow change record to a Microsoft Teams channel using a Webhook Connector. Specify the Webhook URL and Change record to send.</td>
</tr>
<tr>
<td>Post Incident Details</td>
<td>Send details about a ServiceNow incident record to a Microsoft Teams channel using a Webhook Connector. Specify the Webhook URL and Incident record to send.</td>
</tr>
</tbody>
</table>
### Microsoft Teams Inputs

The following inputs are common to the Microsoft Teams actions:

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Required] Webhook URL</td>
<td>The Microsoft Teams webhook for sending a message. Set up the webhook before configuring this action. Refer to the custom incoming webhook for Microsoft Teams documentation.</td>
</tr>
<tr>
<td>[Optional] Title</td>
<td>Title of the message.</td>
</tr>
<tr>
<td>[Optional] Additional Message</td>
<td>Add a message before the record details.</td>
</tr>
<tr>
<td>[Optional] Override Default Fields</td>
<td>You can provide a comma-separated list of field names to send instead of the default fields. Default fields are Short Description, Category, State, Priority, and Assignment Group.</td>
</tr>
<tr>
<td>[Optional] Theme Color (Hex)</td>
<td>Hex code value of color to highlight the message.</td>
</tr>
</tbody>
</table>

### Example

You can add a Microsoft Teams Post Incident Details action to a flow which identifies newly created high priority incidents and a specified theme color.
Microsoft Teams Graph spokev3.3.0

The Microsoft Teams Graph spoke creates and manages teams and channels in Microsoft Teams. To create, manage, or delete users and groups, use the Microsoft Azure AD spoke.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

Note:

- Teams in the Microsoft Teams Graph spoke are created from the groups in Microsoft Azure AD. To create a team using the Microsoft Teams Graph spoke, the associated group must be present in Microsoft Azure AD.
- User and group management can be done using Microsoft Azure AD only and not Microsoft Teams Graph spoke.
- Teams can be created from the Microsoft Office 365 group only.
- The team ID in Microsoft Teams is the same as the group ID of the associated group in Microsoft Azure AD.

IntegrationHub subscription

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Supported version

Microsoft Graph REST API v1.0

Spoke actions

The Microsoft Teams Graph spoke provides actions to automate team and channel tasks when an incident is created in the ServiceNow instance.

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team Management</td>
<td>Create Team</td>
<td>Creates a team from an existing Microsoft Office 365 group.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
<td>The team ID is the same as the group ID.</td>
</tr>
<tr>
<td></td>
<td>Update Team</td>
<td>Updates the properties of a team.</td>
</tr>
<tr>
<td></td>
<td>Get Team</td>
<td>Retrieves the properties and relationships of a team.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Archive Team</td>
<td>Archives a team. Members cannot send messages on the channels of the team. However, members can be added to the group and can search the team content.</td>
</tr>
<tr>
<td></td>
<td>Unarchive Team</td>
<td>Restores an archived team. Members can send messages on the channels of the team.</td>
</tr>
<tr>
<td></td>
<td>Channel Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create Channel in a Team</td>
<td>Creates a channel in a team.</td>
</tr>
<tr>
<td></td>
<td>Get Channel Metadata</td>
<td>Retrieves the properties and relationships of a channel.</td>
</tr>
<tr>
<td></td>
<td>Get Messages From Channel</td>
<td>Retrieves the list of messages in a channel of a team.</td>
</tr>
<tr>
<td></td>
<td>Get Channel ID by Name</td>
<td>Retrieves the channel ID and properties.</td>
</tr>
<tr>
<td></td>
<td>Delete Channel</td>
<td>Removes the channel from a team and deletes all conversations.</td>
</tr>
<tr>
<td></td>
<td>Look Up Channels</td>
<td>Retrieves the list of channels in the specified team.</td>
</tr>
<tr>
<td></td>
<td>Get Messages From Chat</td>
<td>Retrieves the list of messages in a chat.</td>
</tr>
<tr>
<td></td>
<td>Look up Chats</td>
<td>Retrieves the list of chats of a user.</td>
</tr>
</tbody>
</table>

**Note:** Some of the spoke actions require the channel ID, group ID, or team ID as one of the inputs. To learn these details, log in to Microsoft Teams, navigate to Teams, and click **Get link to channel** for the required channel. The channel link contains the required details. For example, if the channel link is https://teams.microsoft.com/l/channel/19%3a1aa3730712e245a0af31e4095d66d613%40thread.skype/New%2520channel%2520in%2520team?groupId=7fb91938-5e8c-4968-bf7d-3987df7716f3&tenantId=a46df9b7-2c9b-49d5-8c9f-d1b3de4ba59f, the group ID and team ID are 7fb91938-5e8c-4968-bf7d-3987df7716f3, and the channel ID is 19:1aa3730712e245a0af31e4095d66d613@thread.skype or 1aa3730712e245a0af31e4095d66d613.

For more information about accessing the channel ID and group ID through Microsoft Teams, see Microsoft Teams documentation.

**Microsoft Teams Graph spoke action permissions**

The Microsoft Teams Graph spoke should have the following permissions to perform the relevant actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Permission type</th>
<th>Permissions (from least to most privileged)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Team</td>
<td>Delegated (work or school account)</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td>Action</td>
<td>Permission type</td>
<td>Permissions (from least to most privileged)</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td>Update Team</td>
<td>Delegated (work or school account)</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.Read.All, Group.ReadWrite.All</td>
</tr>
<tr>
<td>Get Team</td>
<td>Delegated (work or school account)</td>
<td>Group.Read.All, Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.Read.All, Group.ReadWrite.All</td>
</tr>
<tr>
<td>Archive Team</td>
<td>Delegated (work or school account)</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td>Unarchive Team</td>
<td>Delegated (work or school account)</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td>Create Channel in a Team</td>
<td>Delegated (work or school account)</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.ReadWrite.All</td>
</tr>
<tr>
<td>Get Channel Metadata</td>
<td>Delegated (work or school account)</td>
<td>Group.Read.All, Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.Read.All, Group.ReadWrite.All</td>
</tr>
<tr>
<td>Get Channel ID by Name</td>
<td>Delegated (work or school account)</td>
<td>Group.Read.All, Group.ReadWrite.All</td>
</tr>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.Read.All, Group.ReadWrite.All</td>
</tr>
<tr>
<td>Delete Channel</td>
<td>Delegated (work or school account)</td>
<td>Group.ReadWrite.All</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Action</th>
<th>Permission type</th>
<th>Permissions (from least to most privileged)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Delegated (personal Microsoft account)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Group.ReadWrite.All</td>
</tr>
</tbody>
</table>

For more information about the required permissions, see Microsoft Teams documentation.

**Microsoft account requirements**

The Microsoft Teams Graph spoke requires registering an application using the Microsoft Azure portal to generate OAuth 2.0 tokens.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Credentials and connection information.

**MID Server requirements**

The Microsoft Teams Graph spoke actions use REST calls, which can run on an instance or a MID Server. Use the connection record associated with the Microsoft alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

**Set up Microsoft Teams Graph spoke**

Integrate the ServiceNow instance and Microsoft Teams account by creating a custom OAuth application in Microsoft Teams to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Activate the Microsoft Teams Graph spoke
- Role required: admin

*Register an application using the Microsoft Azure portal*

Provide authorization to the ServiceNow instance by registering an application with Azure AD.

Role required: Azure Active Directory admin

Complete these steps from the Microsoft Azure portal. For instructions on registering an application, see the Microsoft Azure documentation.

1. In the Microsoft Azure portal, copy and record the **Directory ID** for later use.
2. Register your application by providing the ServiceNow instance URL for the **Home page**.
3. Copy and record the **Application ID** for later use.
4. Add the **Reply URLs** in this format: `https://<instance-name>.service-now.com/oauth_redirect.do`
5. For the **Required Permissions**, select **Microsoft Graph**.
6. Record the **Client Secret** for use in later configurations.

The ServiceNow application is created with Microsoft Azure AD.
Register Microsoft Teams as the OAuth provider
Register Microsoft Teams as the OAuth provider so that the ServiceNow instance can request OAuth 2.0 tokens.

Use the information generated during the registration of the application in the Microsoft Azure portal.

1. Navigate to System OAuth > Application Registry.
2. Click New.
   The system displays the message, What kind of OAuth application?
3. Select Connect to a third party OAuth Provider.
4. On the form, fill in the fields.

### Application Registrations form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, MS Teams.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Application ID created during application registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client secret created during application registration.</td>
</tr>
<tr>
<td>OAuth API Script</td>
<td>Optional script to customize the request and response.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>URL that contains an image to use as the application logo.</td>
</tr>
<tr>
<td>Default Grant Type</td>
<td>Grant type used to establish the token. Select Authorization Code.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. The default time is 8,640,0000 seconds.</td>
</tr>
<tr>
<td>PKCE required</td>
<td>Option to enable public clients to require PKCE for an authorization.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope that contains this record.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Application scope that this registry is accessible from.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the application registry.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>OAuth server token revocation endpoint.</td>
</tr>
</tbody>
</table>
ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint. Enter https://&lt;instance-name&gt;.service-now.com/oauth_redirect.do</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. This option requires a mutual authentication profile to be specified.</td>
</tr>
<tr>
<td>Send Credentials</td>
<td>Client credentials in the request.</td>
</tr>
</tbody>
</table>

5. Insert the following records in the OAuth Entity Scopes related list.

**Record 1 in the OAuth Entity Scopes related list**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>auth_code</td>
</tr>
<tr>
<td>OAuth scope</td>
<td>offline_access</td>
</tr>
</tbody>
</table>

**Record 2 in the OAuth Entity Scopes related list**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>openid</td>
</tr>
<tr>
<td>OAuth scope</td>
<td>openid</td>
</tr>
</tbody>
</table>

6. Right-click the form header, and click **Save**.
A system-generated OAuth entity profile is created and displayed in the OAuth Entity Profiles related list. For example, MS Teams default_profile.

*Create Credential records for the Microsoft Teams Graph spoke*

Authorize the Microsoft Teams Graph spoke actions by creating credential records for the application registered in the Microsoft Azure portal. The Microsoft Teams Graph spoke connection and credential alias uses these credentials to authorize actions.

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   The system displays the message, *What type of Credentials would you like to create?*
3. Select **OAuth 2.0 Credentials**.
4. On the form, fill in the fields.

**OAuth 2.0 Credentials form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, MSTeamsCredentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile created during the registration of Microsoft Teams Graph spoke as an OAuth provider. For example, MS Teams default_profile.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential. For example, select <strong>All MID Servers</strong>.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the credentials are used. For example, enter <strong>100</strong>.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Save**.
6. To generate the OAuth token, click the **Get OAuth Token** related link.

The credential record for the Microsoft Teams Graph spoke is created.

*Create Connection records for the Microsoft Teams Graph spoke*

Perform actions in Microsoft Teams by creating connection records for your Microsoft Teams account. The Microsoft Teams Graph spoke connection and credential alias uses these connections to perform actions.

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the Microsoft Teams Graph spoke record.
3. In the Connections related list, click **New**.
4. On the form, fill in the fields.

**HTTP(s) Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, <strong>MSTeamsConnection</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Microsoft Teams. For example, <strong>MSTeamsCredentials</strong>.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td><strong>Note:</strong> Do not select the check box.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL. Enter <strong><a href="https://graph.microsoft.com">https://graph.microsoft.com</a></strong>.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. Click **Update**.

The Microsoft Teams Graph spoke is set up and integrated with the ServiceNow instance.

**Regenerate the Microsoft Teams OAuth token**

Authorize the Microsoft Teams Graph spoke by regenerating the Microsoft Teams OAuth token after it expires.

Role required: admin

1. Navigate to **Connections & Credentials > Credentials**.
2. Select the Microsoft Teams Graph spoke OAuth Credential record.
3. To regenerate the OAuth token, click the **Get OAuth Token** related link.
The Microsoft Teams Graph spoke receives a new OAuth access token.

**Okta spoke**

Use Okta to manage users, passwords, and groups.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Supported versions**

API version v1.

**Spoke flows**

The Okta spoke provides sample flows in the draft state to demonstrate automating user and group management tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add User to Okta Group</td>
<td>When a user is created, adds the user to the specified group.</td>
</tr>
<tr>
<td>Onboard User in Okta</td>
<td>When a user is created in ServiceNow, creates and activates the user in Okta.</td>
</tr>
<tr>
<td>Remove Okta Group Membership on Deactivation</td>
<td>When a user is deactivated, removes the user from all Okta groups.</td>
</tr>
</tbody>
</table>

**Note:** Okta has the ServiceNow_UD application to provision users in ServiceNow. ServiceNow can also be configured to provision users in Okta. Hence, ServiceNow administrators must ensure that circular user creation does not occur.

**Spoke actions**

The Okta spoke provides actions to authenticate and manage users and groups. Available actions include:
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Management</td>
<td>Activate User</td>
<td>Starts the process of activating a user in Okta by enabling new or returning users to configure their Okta account from an activation URL. This action can either have Okta send the activation URL to the user as an email, or it can return the activation URL as a data pill for use in a later action to send an email or notification.</td>
</tr>
<tr>
<td></td>
<td>Clear User Session</td>
<td>Clears all active sessions the specified user has with Okta, which forces the user to log back in the next time they use Okta.</td>
</tr>
<tr>
<td></td>
<td>Create User</td>
<td>Creates the specified user in Okta with the specified standard, optional, and mandatory field values.</td>
</tr>
<tr>
<td></td>
<td>Note: Okta has the ServiceNow_UD application to provision users in ServiceNow. ServiceNow can also be configured to provision users in Okta. Hence, ServiceNow administrators must ensure that circular user creation does not occur.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deactivate User</td>
<td>Deactivates the specified user in Okta, which removes the user’s groups and application assignments, and changes the user status to DEACTIVATED. This action is commonly used when a user departs the company indefinitely.</td>
</tr>
<tr>
<td></td>
<td>Note: Do not perform this action on users with a DEPROVISIONED status.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete User</td>
<td>Deletes the specified user within Okta, which completely removes the user. This action is commonly used to clean up your user base after compliance regulations have been met.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ServiceNow</td>
<td>Is Account Locked</td>
<td>Determines if a user account is locked.</td>
</tr>
<tr>
<td>DocVersion</td>
<td>Lookup Okta User ID</td>
<td>Retrieves the Okta user ID for the specified Okta login ID or login short name.</td>
</tr>
<tr>
<td>Now Platform capabilities</td>
<td>Lookup User Account Details</td>
<td>Retrieves user details for the specified Okta user ID.</td>
</tr>
<tr>
<td></td>
<td>Lookup User Profile Information</td>
<td>Retrieves user profile details for the specified Okta user ID.</td>
</tr>
<tr>
<td></td>
<td>Restart User Activation</td>
<td>Restarts the specified user's activation within Okta. Use this action if the user did not complete their activation with the activation code or link provided by the <strong>Activate User</strong> Action.</td>
</tr>
<tr>
<td></td>
<td>Suspend User</td>
<td>Suspends the specified user within Okta by changing the user status from ACTIVE to SUSPENDED. For example, use this action to suspend access for users who are on temporary leave. To reactivate a suspended user, use the <strong>Unsuspend</strong> action.</td>
</tr>
<tr>
<td></td>
<td>Unsuspend User</td>
<td>Unsuspends the specified user in Okta.</td>
</tr>
<tr>
<td></td>
<td>Update User Profile</td>
<td>Updates the user profile details for the specified user in Okta.</td>
</tr>
<tr>
<td>Password Management</td>
<td>Change User's Password</td>
<td>Changes the specified user's password after validating the user's current password.</td>
</tr>
<tr>
<td></td>
<td>Expire User Password</td>
<td>Expires the specified user's password within Okta. This action is commonly used as a reaction to stop breaching attempts.</td>
</tr>
<tr>
<td></td>
<td>Reset to Temporary Password</td>
<td>Resets the specified user's password within Okta to a temporary password. This action is commonly used to get a user logged in who has forgotten their password.</td>
</tr>
<tr>
<td></td>
<td>Reset User Factors</td>
<td>Resets all of the multi-factor access devices for the specified user within Okta. This action is commonly used when a user loses their multi-factor authentication device or method.</td>
</tr>
<tr>
<td></td>
<td>Set User Password</td>
<td>Sets the specified user's password in Okta.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------</td>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td>Group Management</td>
<td>Unlock User</td>
<td>Unlocks the specified user in Okta.</td>
</tr>
<tr>
<td></td>
<td>Add User To Group</td>
<td>Adds the specified user to the specified group in Okta.</td>
</tr>
<tr>
<td></td>
<td>Create Group</td>
<td>Creates the specified group in Okta.</td>
</tr>
<tr>
<td></td>
<td>Is User In Group</td>
<td>Determines if the specified user is a member of the specified group in Okta.</td>
</tr>
<tr>
<td></td>
<td>Lookup Group Details</td>
<td>Retrieves group details for the specified Okta group ID.</td>
</tr>
<tr>
<td></td>
<td>Lookup Group ID By Name</td>
<td>Retrieves group details and group ID for the specified Okta group name.</td>
</tr>
<tr>
<td></td>
<td>Remove User From Group</td>
<td>Removes the specified user from the specified Okta group ID.</td>
</tr>
<tr>
<td></td>
<td>Update Group</td>
<td>Updates the group details for the specified Okta group ID.</td>
</tr>
</tbody>
</table>

### Okta account requirements

The Okta spoke requires generating and configuring your Okta account to use a web API key.

### Credential and connection alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Credentials and connection information.

This spoke uses the Okta Connection & Credential Alias record to authorize actions.

### MID Server requirements

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Okta alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

### Set up Okta spoke

Integrate the ServiceNow instance and your Okta account using an API key to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Activate the Okta spoke
- Role required: admin
Generate Okta account API token
Configure your Okta account to generate an access token for API key authentication.

Okta requirements:
- Okta organization or developer account
- Okta administrator credentials

Complete these steps from your Okta organization or developer account. See the Okta for developers documentation for instructions on creating and configuring your account.

1. Generate an access token to interact with Okta APIs.
2. Record the access token to create Credential records on your ServiceNow instance.

Create Credential records for the Okta spoke
Create Credential records to the Okta application you created. The Okta spoke connection and credential alias uses these credentials to authorize actions.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message What type of Credentials would you like to create?.
3. Select API Key Credentials.
   A blank API Key Credentials form displays.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Okta Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>API Key</td>
<td>Enter SSWS followed by the access token you obtained from Okta. For example, SSWS {access token}.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select All MID Servers.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create Connection records for the Okta spoke
Create a Connection record to the Okta API. The Okta spoke connection and credential alias uses these connections to perform actions in Okta.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open for the record for Okta.
3. From the Connections tab, click New.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Okta Connection.</td>
</tr>
</tbody>
</table>
Field | Value required
---|---
Credential | Select the Credential record you created for Okta. For example, select **Okta Credentials**.
Connection URL | Enter your Okta organization URL. For example, https://dev-418994.oktapreview.com.

5. Click **Submit**.

**Okta spoke v1.1.1**

Use Okta to manage users, passwords, and groups.

**Request apps on the Store**

Visit the **ServiceNow Store** website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the **ServiceNow Store version history release notes**.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Professional subscription package. For more information, see Request IntegrationHub.

**Spoke dependencies**

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

- ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
- ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)
- ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

**Note**: Some of these plugins are licensable features and require appropriate license, if used outside the spoke implementation.

**Supported versions**

API version v1.

**Spoke flows**

The Okta spoke provides sample flows in the draft state to demonstrate automating user and group management tasks. To customize a sample flow, copy it to a new application scope. Available sample flows include:
<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add User to Okta Group</td>
<td>When a user is created, adds the user to the specified group.</td>
</tr>
<tr>
<td>Onboard User in Okta</td>
<td>When a user is created in ServiceNow, creates and activates the user in Okta.</td>
</tr>
<tr>
<td>Remove Okta Group Membership on Deactivation</td>
<td>When a user is deactivated, removes the user from all Okta groups.</td>
</tr>
</tbody>
</table>

**Note:** Okta has the ServiceNow_UD application to provision users in ServiceNow. ServiceNow can also be configured to provision users in Okta. Hence, ServiceNow administrators must ensure that circular user creation does not occur.

## Spoke actions

The Okta spoke provides actions to authenticate and manage users and groups. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Management</td>
<td>Activate User</td>
<td>Starts the process of activating a user in Okta by enabling new or returning users to configure their Okta account from an activation URL. This action can either have Okta send the activation URL to the user as an email, or it can return the activation URL as a data pill for use in a later action to send an email or notification.</td>
</tr>
<tr>
<td></td>
<td>Clear User Session</td>
<td>Clears all active sessions the specified user has with Okta, which forces the user to log back in the next time they use Okta.</td>
</tr>
<tr>
<td></td>
<td>Create User</td>
<td>Creates the specified user in Okta with the specified standard, optional, and mandatory field values.</td>
</tr>
</tbody>
</table>

**Note:** Okta has the ServiceNow_UD application to provision users in ServiceNow. ServiceNow can also be configured to provision users in Okta. Hence, ServiceNow administrators must ensure that circular user creation does not occur.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deactivate User</td>
<td>Deactivate User</td>
<td>Deactivates the specified user in Okta, which removes the user's groups and application assignments, and changes the user status to DEACTIVATED. This action is commonly used when a user departs the company indefinitely.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Do not perform this action on users with a DEPROVISIONED status.</td>
</tr>
<tr>
<td>Delete User</td>
<td>Delete User</td>
<td>Deletes the specified user within Okta, which completely removes the user. This action is commonly used to clean up your user base after compliance regulations have been met.</td>
</tr>
<tr>
<td>Is Account Locked</td>
<td>Is Account Locked</td>
<td>Determines if a user account is locked.</td>
</tr>
<tr>
<td>Lookup Okta User ID</td>
<td>Lookup Okta User ID</td>
<td>Retrieves the Okta user ID for the specified Okta login ID or login short name.</td>
</tr>
<tr>
<td>Lookup User Account Details</td>
<td>Lookup User Account Details</td>
<td>Retrieves user details for the specified Okta user ID.</td>
</tr>
<tr>
<td>Lookup User Profile Information</td>
<td>Lookup User Profile Information</td>
<td>Retrieves user profile details for the specified Okta user ID.</td>
</tr>
<tr>
<td>Restart User Activation</td>
<td>Restart User Activation</td>
<td>Restarts the specified user's activation within Okta. Use this action if the user did not complete their activation with the activation code or link provided by the <strong>Activate User</strong> Action.</td>
</tr>
<tr>
<td>Suspend User</td>
<td>Suspend User</td>
<td>Suspends the specified user within Okta by changing the user status from ACTIVE to SUSPENDED. For example, use this action to suspend access for users who are on temporary leave. To reactivate a suspended user, use the <strong>Unsuspend</strong> action.</td>
</tr>
<tr>
<td>Unsuspend User</td>
<td>Unsuspend User</td>
<td>Unsuspends the specified user in Okta.</td>
</tr>
<tr>
<td>Update User Profile</td>
<td>Update User Profile</td>
<td>Updates the user profile details for the specified user in Okta.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password Management</td>
<td>Change User's Password</td>
<td>Changes the specified user's password after validating the user's current password.</td>
</tr>
<tr>
<td></td>
<td>Expire User Password</td>
<td>Expires the specified user's password within Okta. This action is commonly used as a reaction to stop breaching attempts.</td>
</tr>
<tr>
<td></td>
<td>Reset to Temporary Password</td>
<td>Resets the specified user's password within Okta to a temporary password. This action is commonly used to get a user logged in who has forgotten their password.</td>
</tr>
<tr>
<td></td>
<td>Reset User Factors</td>
<td>Resets all of the multi-factor access devices for the specified user within Okta. This action is commonly used when a user loses their multi-factor authentication device or method.</td>
</tr>
<tr>
<td></td>
<td>Set User Password</td>
<td>Sets the specified user's password in Okta.</td>
</tr>
<tr>
<td></td>
<td>Unlock User</td>
<td>Unlocks the specified user in Okta.</td>
</tr>
<tr>
<td>Group Management</td>
<td>Add User To Group</td>
<td>Adds the specified user to the specified group in Okta.</td>
</tr>
<tr>
<td></td>
<td>Create Group</td>
<td>Creates the specified group in Okta.</td>
</tr>
<tr>
<td></td>
<td>Get Groups</td>
<td>Retrieves all new and updated groups in Okta.</td>
</tr>
<tr>
<td></td>
<td>Is User In Group</td>
<td>Determines if the specified user is a member of the specified group in Okta.</td>
</tr>
<tr>
<td></td>
<td>Lookup Group Details</td>
<td>Retrieves group details for the specified Okta group ID.</td>
</tr>
<tr>
<td></td>
<td>Lookup Group ID By Name</td>
<td>Retrieves group details and group ID for the specified Okta group name.</td>
</tr>
<tr>
<td></td>
<td>Remove User From Group</td>
<td>Removes the specified user from the specified Okta group ID.</td>
</tr>
<tr>
<td></td>
<td>Update Group</td>
<td>Updates the group details for the specified Okta group ID.</td>
</tr>
</tbody>
</table>

**Okta account requirements**

The Okta spoke requires generating and configuring your Okta account to use a web API key.
Credential and connection alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Credentials and connection information.

This spoke uses the Okta Connection & Credential Alias record to authorize actions.

MID Server requirements

These actions use REST calls, which can run on an instance or MID Server. Use the connection record associated with the Okta alias to configure where actions run as well as set MID Server selection attributes. For more information, see MID server.

Set up Okta spoke v1.1.1

Integrate the ServiceNow instance and your Okta account using an API key to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Activate the Okta spoke
- Role required: admin

Generate Okta account API token

Configure your Okta account to generate an access token for API key authentication.

Okta requirements:

- Okta organization or developer account
- Okta administrator credentials

Complete these steps from your Okta organization or developer account. See the Okta for developers documentation for instructions on creating and configuring your account.

1. Generate an access token to interact with Okta APIs.
2. Record the access token to create Credential records on your ServiceNow instance.

Create Credential records for the Okta spoke v1.1.1

Create Credential records to the Okta application you created. The Okta spoke connection and credential alias uses these credentials to authorize actions.

1. Navigate to Connections & Credentials > Credentials.
2. Click New. The system displays the message What type of Credentials would you like to create?
3. Select API Key Credentials.
   A blank API Key Credentials form displays.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Okta Credentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
</tbody>
</table>
### Create Connection records for the Okta spoke v1.1.1

Create a Connection record to the Okta API. The Okta spoke connection and credential alias uses these connections to perform actions in Okta.

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open the record for **Okta**.
3. From the **Connections** tab, click **New**.
   
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter Okta Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for Okta. For example, select Okta Credentials.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter your Okta organization URL. For example, <a href="https://dev-418994.oktapreview.com">https://dev-418994.oktapreview.com</a>.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

### Fetch Okta groups

Fetch Okta groups into your instance so that you can assign them to different users. You can fetch the groups on an as-needed or scheduled basis.

**Role required:** okta.admin

1. To fetch Okta groups on an as-needed basis.
   a) Navigate to **Okta spoke > Okta groups**.
   b) Click **Fetch Okta groups**.
   c) From the Okta groups list, you can review the following:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the Okta group.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the Okta group.</td>
</tr>
<tr>
<td>Group ID</td>
<td>Group ID of the Okta group.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the Okta group.</td>
</tr>
</tbody>
</table>
### ServiceNow eBonding spoke

The ServiceNow eBonding spoke demonstrates some common integration design patterns through a common use case of synchronizing incidents across ServiceNow instances.

**Note:** Because the eBonding Example spoke includes sample actions to demonstrate integrating with a remote instance, it does not require a subscription package.

### Base system eBonding actions

If you have multiple production instances in your environment, you might have a need to synchronize data across these instances. For example, one instance might manage internal applications (your source system) and another manages external customer facing applications (your target system). A common use case is an incident which initially opens on the source system, but it requires a correlated incident to be created and tracked on the target instance. The ServiceNow eBonding integration contains the following OOB actions to assist in creating the synchronization:

#### Create Remote Incident action

This action uses the source system incident details to create a new incident on the target instance. It passes the source incident number as the Correlation ID on the target system. It takes the target system incident number and updates the Correlation ID of the source system.
Lookup Remote Incident action

This action takes the remote incident number as input and retrieves more details about that incident, such as: short description, description, priority, etc.

Update Remote Incident action

This action uses the source incident details to update the remote incident with details from source instance. Look up of remote incident is performed using Correlation ID in source instance’s incident.

Credential and Connection information for eBonding

When building actions, you must decouple the connection and credential information from the action so there is a seamless transition from distinct production environments. This also makes it easier to share content and create content through the ServiceNow store.

As part of eBonding example, you can associate an OOB connection alias (sn_ebonding_ah.ServiceNow). Create an HTTP connection record and associate it with this alias. For credentials, ServiceNow web services supports a multitude of authentication mechanisms. Create a BasicAuth credential to start with, however, that login ID must have permissions to create, read, and update an incident on your remote system. An example HTTP connection:

Additional eBonding Script

The Payloadbuilder script is included with this example. It builds a payload by reading a set of fields from an incident table used in the REST steps for these actions.

Slack spoke

Use Slack to post messages and manage access to channels.

IntegrationHub subscription

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.
Spoke flows

This spoke has no sample flows.

Spoke subflows

This spoke has no sample subflows.

Spoke actions

The Slack spoke provides actions to automate Slack workspace tasks when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Management</td>
<td>Add User to Channel</td>
<td>Adds an existing user to the specified channel in a Slack workspace.</td>
</tr>
<tr>
<td></td>
<td>Archive Channel</td>
<td>Archives the specified channel in a Slack workspace.</td>
</tr>
<tr>
<td></td>
<td>Create Channel</td>
<td>Creates the specified channel in a Slack workspace.</td>
</tr>
<tr>
<td></td>
<td>Remove User from Channel</td>
<td>Removes a user from the specified channel in the Slack workspace.</td>
</tr>
</tbody>
</table>

**Note:** To perform the channel management actions, enable these Slack application scope permissions:
- `channels:write`
- `groups:write`
- `im:write`
- `mpim:write`

For more information, see Configure Slack workspace.

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification Management</td>
<td>Post a Message</td>
<td>Posts a message in the specified channel.</td>
</tr>
<tr>
<td></td>
<td>Post Change Details</td>
<td>Posts Change record details to the specified channel.</td>
</tr>
<tr>
<td></td>
<td>Post Incident Details</td>
<td>Posts Incident record details to the specified channel.</td>
</tr>
<tr>
<td></td>
<td>Post Problem Details</td>
<td>Posts Problem record details to the specified channel.</td>
</tr>
</tbody>
</table>

**Note:** To perform the notification management actions, enable these Slack application scope permissions:
- `chat:write`
- `chat:write:bot`
- `chat:write:user`

For more information, see Configure Slack workspace.
<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Management</td>
<td>Create User</td>
<td>Creates a user in the specified Slack workspace.</td>
</tr>
<tr>
<td></td>
<td>Deactivate User</td>
<td>Deactivates the specified user from a Slack workspace.</td>
</tr>
<tr>
<td></td>
<td>Lookup User</td>
<td>Returns information about the specified user such as name, time zone, workspace admin rights, and team ownership.</td>
</tr>
</tbody>
</table>

**Note:** To perform the user management actions, enable these Slack application scope permissions:

- users:read.email
- users:read
- admin

For more information, see Configure Slack workspace.

**Slack account requirements**

The Slack spoke requires creating a custom app on your Slack account to generate OAuth 2.0 tokens for the Slack spoke. See Configure Slack workspace.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection information and OAuth credentials. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you do not need to update any actions that use the connection.

This spoke uses the Slack alias record to authorize actions on Slack.

<table>
<thead>
<tr>
<th>Connection alias</th>
<th>Description</th>
<th>Connection URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slack</td>
<td>Connection to Slack.</td>
<td><a href="https://slack.com">https://slack.com</a></td>
</tr>
</tbody>
</table>

**Set up Slack spoke**

Integrate the ServiceNow instance and your Slack account by creating a custom OAuth application in Slack to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Role required: admin

*Configure Slack workspace*

Create a custom OAuth application on your Slack workspace to enable OAuth 2.0 authentication with the Slack spoke.

Slack requirements:

- Slack account
- Slack workspace owner credentials for admin scope permissions
Complete these steps from your Slack account. See the Slack API documentation for instructions on creating and configuring custom applications.

1. From your Slack account, create a custom OAuth application.
2. Select standard OAuth 2.0 user authentication as the application authentication method.
3. Record the application client ID and client secret to register the app as a third-party OAuth provider on your ServiceNow instance.
4. Enable the matching Slack application scope permissions you want the app to support.

<table>
<thead>
<tr>
<th>Slack application scope permission</th>
<th>Required for</th>
</tr>
</thead>
<tbody>
<tr>
<td>chat:write</td>
<td>Post Message, Post Incident Details, Post Change Details, Post Problem Details actions, and Send messages as your Slack app</td>
</tr>
<tr>
<td>chat:write:bot</td>
<td></td>
</tr>
<tr>
<td>chat:write:user</td>
<td></td>
</tr>
<tr>
<td>channels:write</td>
<td>Create Channel, Achieve Channel, Add User to Channel, and Remove User from Channel actions</td>
</tr>
<tr>
<td>groups:write</td>
<td></td>
</tr>
<tr>
<td>im:write</td>
<td></td>
</tr>
<tr>
<td>mpim:write</td>
<td></td>
</tr>
<tr>
<td>users:read.email</td>
<td>Lookup User action</td>
</tr>
<tr>
<td>users:read</td>
<td></td>
</tr>
<tr>
<td>admin (Only available to Slack workspace owners)</td>
<td>Create User and Deactivate User actions.</td>
</tr>
</tbody>
</table>

Register Slack as OAuth provider

Use the information generated during Slack workspace configuration to register Slack as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

• Request IntegrationHub subscription
• Configure Slack workspace
• Role required: admin

1. Navigate to System OAuth > Application Registry.
2. Click New.
   The system displays the message What kind of OAuth application?
3. Select Connect to a third party OAuth Provider.
   The system displays a blank Application Registries form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter Slack OAuth.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Enter the Client ID you created during the Slack workspace configuration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Enter the Client Secret you created during the Slack workspace configuration.</td>
</tr>
<tr>
<td>Default Grant type</td>
<td>Select Authorization Code.</td>
</tr>
</tbody>
</table>
5. Right-click the form header, and click **Save**. The system validates the OAuth credentials and populates the **OAuth Entity Profiles** related list and **Redirect URL**.

6. In the **OAuth Entity Scopes** related list, create entries for the same scopes you had configured in your Slack workspace in this format.

<table>
<thead>
<tr>
<th>Name</th>
<th>OAuth scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>chat:write</td>
<td>chat:write</td>
</tr>
<tr>
<td>chat:write:bot</td>
<td>chat:write:bot</td>
</tr>
<tr>
<td>chat:write:user</td>
<td>chat:write:user</td>
</tr>
<tr>
<td>channels:write</td>
<td>channels:write</td>
</tr>
<tr>
<td>groups:write</td>
<td>groups:write</td>
</tr>
<tr>
<td>im:write</td>
<td>im:write</td>
</tr>
<tr>
<td>mpim:write</td>
<td>mpim:write</td>
</tr>
<tr>
<td>users:read.email</td>
<td>users:read.email</td>
</tr>
<tr>
<td>users:read</td>
<td>users:read</td>
</tr>
<tr>
<td>admin</td>
<td>admin</td>
</tr>
</tbody>
</table>

**Note:** This scope is available to Slack workspace owners only.

7. Open the default record in the **OAuth Entity Profiles** related list. In the **OAuth Entity Profile Scopes** related list, specify the same scopes you had earlier specified in the **OAuth Entity Scopes** related list.

8. Copy the value from **Redirect URL**.

9. Login to your Slack workspace to edit the configuration of your custom Slack application. See the [Slack API](https://api.slack.com) for instructions.

10. Paste the **Redirect URL** value into the OAuth 2.0 Redirect URI for your custom Slack application. For example, paste `https://instance.service-now.com/oauth_redirect.do`.

The instance can request OAuth 2.0 tokens for the spoke.

**Note:** The spoke generates OAuth tokens that expire after 24 days. An administrator can regenerate the spoke OAuth token every 24 days.

*Create Credential record for the Slack spoke*  
Create a Credential record for the Slack custom OAuth application you created during Slack workspace configuration. The Slack spoke connection and credential alias uses this credential to authorize actions.

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.  
The system displays the message *What type of Credentials would you like to create?*.  
3. Select **OAuth 2.0 Credentials**.  
The pop-up window displays a blank OAuth 2.0 Credentials form.  
4. Enter these values.  

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the record. For example, enter <em>Slack Credential</em>.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>Select the OAuth profile you created when you registered the custom Slack application as an OAuth provider. For example, select <em>Slack OAuth default profile</em>.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Servers that can use this credential. For example, select <em>All MID Servers</em>.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the order to apply this credential. For example, enter <em>100</em>.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

*Create Connection record for the Slack spoke*  
Create a Connection record to your Slack workspace. The Slack spoke connection and credential alias uses this connection to perform actions on your Slack workspace.  

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.  
2. Open for the record for Slack.  
3. From the **Connections** tab, click **New**.  
The system displays a blank HTTP(s) Connection form.  
4. Enter these values.  

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter any name to uniquely identify the connection record. For example, enter <em>Slack Connection</em>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Select the Credential record you created for the Slack workspace. For example, select <em>Slack Credential</em>.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter <em><a href="https://api.slack.com">https://api.slack.com</a></em>.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

*Regenerate Slack OAuth token*  
Regenerate the Slack OAuth token when it expires. The Box spoke OAuth token expires every twenty four days.  

1. Navigate to **Connections & Credentials > Credentials**.  
2. Select the Slack spoke OAuth Credential record. For example, select *Slack Credential*.  
3. From Related Links, click **Get OAuth Token**.  
The Slack spoke receives a new OAuth access token good for 24 days.
Slack webhooks spoke

Use Slack webhooks to post messages and record details for ServiceNow incidents, problems, and changes to Slack channels.

IntegrationHub subscription

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Spoke actions

The Slack webhooks spoke is an available integration through IntegrationHub. You can specify the following Slack actions within a flow:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post a Message</td>
<td>Send a message to a Slack channel using an Incoming Webhook. Specify the Webhook URL and Message to send.</td>
</tr>
<tr>
<td>Post Change Details</td>
<td>Send details about a ServiceNow change record to a Slack channel using a Webhook Connector. Specify the Webhook URL and Change record to send.</td>
</tr>
<tr>
<td>Post Incident Details</td>
<td>Send details about a ServiceNow incident record to a Slack channel using a Webhook Connector. Specify the Webhook URL and Incident record to send.</td>
</tr>
<tr>
<td>Post Problem Details</td>
<td>Send details about a ServiceNow problem record to a Slack channel using a Webhook Connector. Specify the Webhook URL and Problem record to send.</td>
</tr>
</tbody>
</table>

Slack Inputs

The following inputs are common to Slack webhooks spoke actions:

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Required] Webhook URL</td>
<td>The Slack webhook for sending a message. Set up the webhook before configuring this action. Refer to the custom incoming webhook for Slack documentation.</td>
</tr>
<tr>
<td>[Optional] Additional Message</td>
<td>Add a message before the record details.</td>
</tr>
<tr>
<td>[Optional] Channel</td>
<td>Specify the Slack channel to post information.</td>
</tr>
<tr>
<td>Username</td>
<td>Specify a username to include in your post.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
### Input

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Optional] Override Default Field</td>
<td>You can provide a comma-separated list of field names to send instead of the default fields. Default fields are Short Description, Category, State, Priority, and Assignment Group.</td>
</tr>
<tr>
<td>[Optional] Icon</td>
<td>Add an icon to the communication.</td>
</tr>
</tbody>
</table>

**Note:** If you do not specify a Username, Channel, or Icon, it will post the message using the defaults as configured in your webhook. If you specify them here, they will override those defaults.

**Example**

You can add a Slack Post Incident Details action to a flow which identifies newly created high priority incidents, a username, and a specific slack channel.
Twilio spoke v1.1.2

Use the Twilio spoke to send SMS, make voice calls, create conference calls, manage calls, manage short codes, notify services, and messaging services.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.
IntegrationHub subscription

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Supported versions

This spoke was built for Twilio Base version 2010-04-01, Twilio Messaging version v1, and Twilio Notify version v1, but may be compatible with later versions.

Spoke requirements

- Twilio account.
- AccountSid and AuthToken of the account to create a Basic Auth credential.
- Activate these plugins:
  - ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
  - ServiceNow IntegrationHub Action Template - Data Stream (com.glide.hub.action_type.datastream)
  - ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

See Twilio documentation for instructions on creating an account.

Spoke actions

The Twilio spoke provides actions to automate sending SMS, making voice calls, and creating conference calls when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Create Application</td>
<td>Creates an application resource in a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Delete Application</td>
<td>Deletes an application resource from a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Get Application</td>
<td>Retrieves the required application resource.</td>
</tr>
<tr>
<td></td>
<td>Look Up Accounts</td>
<td>Retrieves the account resources in a Twilio account. The list includes the account and its sub-account resources.</td>
</tr>
<tr>
<td></td>
<td>Look Up Applications</td>
<td>Retrieves the application resources in a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Update Application</td>
<td>Updates properties of an application resource in a Twilio account.</td>
</tr>
<tr>
<td>Call Management</td>
<td>Dequeue Call</td>
<td>Removes a call from a queue.</td>
</tr>
<tr>
<td></td>
<td>Get Call</td>
<td>Retrieves the required call resource.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Get Incoming Phone Number</td>
<td>Retrieves the incoming phone number resource.</td>
</tr>
<tr>
<td></td>
<td>Hang Up Call</td>
<td>Ends a call in progress.</td>
</tr>
<tr>
<td></td>
<td>Look Up Incoming Phone Numbers</td>
<td>Retrieves the incoming phone number resources in a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Make a Call With Recording</td>
<td>Places a call to a phone number and records the call.</td>
</tr>
<tr>
<td></td>
<td>Make a Call Without Recording</td>
<td>Places a call to a phone number and doesn't record the call.</td>
</tr>
<tr>
<td></td>
<td>Modify Call</td>
<td>Modifies a call in progress.</td>
</tr>
<tr>
<td></td>
<td>Mute Or Unmute Participant</td>
<td>Mutes or unmutes a participant resource in a conference call.</td>
</tr>
<tr>
<td></td>
<td>Remove Participant From Conference Call</td>
<td>Removes a participant resource from a conference call.</td>
</tr>
<tr>
<td></td>
<td>Update Incoming Phone Number</td>
<td>Updates properties of an incoming phone number resource in a Twilio account.</td>
</tr>
<tr>
<td>Messaging Service Management</td>
<td>Add Phone Number To Messaging Service</td>
<td>Adds a phone number resource to the messaging service.</td>
</tr>
<tr>
<td></td>
<td>Add Short Code To Messaging Service</td>
<td>Adds a short code resource to the messaging service.</td>
</tr>
<tr>
<td></td>
<td>Create Messaging Service</td>
<td>Creates a new messaging service resource in a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Delete Messaging Service</td>
<td>Deletes a messaging service resource from a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Look Up Messaging Service Phone Numbers</td>
<td>Retrieves the phone number resources in a messaging service.</td>
</tr>
<tr>
<td></td>
<td>Look Up Messaging Service Short Codes</td>
<td>Retrieves the short code resources associated with a messaging service.</td>
</tr>
<tr>
<td></td>
<td>Look Up Messaging Services</td>
<td>Retrieves the messaging service resources in a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Remove Phone Number From Messaging Service</td>
<td>Removes a phone number resource from a messaging service.</td>
</tr>
<tr>
<td></td>
<td>Remove Short Code From Messaging Service</td>
<td>Removes a short code resource from a messaging service.</td>
</tr>
<tr>
<td>Notification Service Management</td>
<td>Create Notify Service</td>
<td>Creates a new notify service resource in a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Delete Notify Service</td>
<td>Deletes a notify service resource from Twilio account.</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Look Up Notify Services</td>
<td>Retrieves the notify service resources in a Twilio account.</td>
</tr>
<tr>
<td>Short Code Management</td>
<td>Get Short Code</td>
<td>Retrieves a short code resource.</td>
</tr>
<tr>
<td></td>
<td>Look Up Short Codes</td>
<td>Retrieves the short code resources of a Twilio account.</td>
</tr>
<tr>
<td></td>
<td>Reset Short Code</td>
<td>Resets the short code resource.</td>
</tr>
<tr>
<td></td>
<td>Update Short Code</td>
<td>Updates properties of a short code resource in a Twilio account.</td>
</tr>
<tr>
<td>Text Messaging</td>
<td>Send Bulk SMS</td>
<td>Sends an SMS to multiple phone numbers.</td>
</tr>
<tr>
<td></td>
<td>Send SMS</td>
<td>Sends an SMS to a phone number.</td>
</tr>
</tbody>
</table>

**Note:** To receive information about Status Callbacks, you must configure webhooks in Twilio. See Twilio documentation for instructions on creating and configuring webhooks.

### Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Credentials and connection information.

**Note:** Three connection and credential alias records are needed for the Twilio spoke; one each for Twilio Base, Twilio Notify, and Twilio Messaging. Each alias should be associated with the respective Twilio API.

### Set up Twilio spoke

Integrate the ServiceNow instance and Twilio using basic authentication to authenticate ServiceNow requests.

- Request IntegrationHub subscription
- Activate Twilio spoke
- Role required: admin

**Create Credential records for the Twilio spoke**

Create Credential records to the Twilio server. The Twilio spoke connection and credential alias uses these credentials to authorize actions.

Create three credential records for the Twilio spoke; one each for Twilio Base, Twilio Notify, and Twilio Messaging. Each credential should be associated with the respective Twilio API.

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   The system displays the message **What type of Credentials would you like to create?**.
3. Select **Basic Auth Credentials**.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter Twilio Base, Twilio Notify, or Twilio Messaging.</td>
</tr>
<tr>
<td>User name</td>
<td>Twilio Account SID.</td>
</tr>
<tr>
<td>Password</td>
<td>Twilio AuthToken.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. For example, enter 100.</td>
</tr>
</tbody>
</table>

5. Click Submit.

The three required credential records are created for Twilio Base, Twilio Notify, and Twilio Messaging.

Create Connection records for the Twilio spoke
Create Connection records to your Twilio account. The Twilio spoke connection and credential alias uses these connections to perform actions on Twilio.

Create three connection records for the Twilio spoke; one each for Twilio Base, Twilio Notify, and Twilio Messaging. Each connection record should be associated with the respective Twilio API.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open record of the Twilio spoke.
3. From the Connections tab, click New.
4. On the form, fill these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. For example, enter Twilio Base Connection, Twilio Notify Connection, or Twilio Messaging Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Twilio. For example, select Twilio Base for Twilio Base Connection.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for Twilio Base, enter <a href="https://api.twilio.com/">https://api.twilio.com/</a>.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for Twilio Notify, enter <a href="https://notify.twilio.com/">https://notify.twilio.com/</a>.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for Twilio Messaging, enter <a href="https://messaging.twilio.com/">https://messaging.twilio.com/</a>.</td>
</tr>
</tbody>
</table>

5. In the Attributes related list:
   • For the connection record of Twilio Base, enter Account SID.
   • Enter Page size.
   • Don't modify the default value of the Version.

6. Click Submit.
The three connection records are created. The ServiceNow instance and Twilio are integrated.

**Twitter spoke**

Use the Twitter spoke to automatically tweet messages or media in your Twitter account from your ServiceNow instance.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

**IntegrationHub subscription**

This spoke requires the IntegrationHub Standard subscription package. For more information, see Request IntegrationHub.

**Supported versions**

API version v1.1.

**Spoke requirements**

- Twitter developer account
- Twitter developer app to access the Twitter APIs
- Access token and secret of your Twitter developer app
- Consumer key and secret from your Twitter developer app

See the Twitter Developers documentation for instructions on creating the developer application and gathering the required details.

**Spoke actions**

The Twitter spoke provides actions to automate tweeting when events occur in ServiceNow. Available actions include:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tweet</td>
<td>Tweets a message or media. Messages and media are tweeted as per Twitter limits.</td>
</tr>
</tbody>
</table>

**Note:** If you wish to tweet media, use the Look Up Attachment Records action before this action in your custom flow to retrieve the required media.
Connection and credential alias requirements

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don’t need to update any actions that use the connection. For more information, see Credentials and connection information.

Note: Two connection and credential alias records are needed for the Twitter spoke; one for tweeting messages and other for tweeting media. Each alias should be associated with the respective Twitter API.

Create Credential records for the Twitter spoke

Authorize the Twitter spoke actions by creating credential records for the application registered in the Twitter developer account. The Twitter spoke connection and credential alias uses these credentials to authorize actions.

You must create two credential records; one for tweeting messages and other for tweeting media.

1. Navigate to Connections & Credentials > Credentials.
2. Click New.
   The system displays the message, What type of Credentials would you like to create?
3. Select Twitter Credentials.
4. On the form, fill in the fields.

Twitter Credentials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, TwitterCredentials.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>Consumer Key</td>
<td>Consumer key of your Twitter developer app.</td>
</tr>
<tr>
<td>Consumer Secret</td>
<td>Consumer secret of your Twitter developer app.</td>
</tr>
<tr>
<td>Access Token</td>
<td>Access token of your Twitter developer app.</td>
</tr>
<tr>
<td>Access Token Secret</td>
<td>Access token secret of your Twitter developer app.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Credential alias record associated with this credential.</td>
</tr>
</tbody>
</table>

Note:
- If the credential record is created for tweeting messages, select the credential alias that is associated with the Twitter messaging API.
- If the credential record is created for tweeting media, select the credential alias that is associated with the Twitter media API.
5. Right-click the form header and click Save.

The credential record for the Twitter spoke is created.

Create Connection records for the Twitter spoke

Perform actions in Twitter by creating connection records for your Twitter account. The Twitter spoke connection and credential alias uses these connections to perform actions.

Two connection and credential alias records are available by default; one for tweeting messages and other for tweeting media. Perform these steps to associate each alias with the respective Twitter API.

1. Navigate to Connections & Credentials > Connection & Credential Aliases.
2. Open the required Twitter spoke record.

   **Note:** There are two connection and credential records; Twitter and Twitter_Media. The Twitter record is for tweeting messages and Twitter_Media is for tweeting media.

3. In the Connections related list of the required record, click New.
4. On the form, fill in the fields.

   **HTTP(s) Connection form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, Twitter Base or Twitter Media.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record created for Twitter spoke. For example, Twitter.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Note: Do not select the check box.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for tweeting messages, enter <a href="https://api.twitter.com">https://api.twitter.com</a>.</td>
</tr>
<tr>
<td></td>
<td>• If the connection record is for tweeting media, enter <a href="https://upload.twitter.com">https://upload.twitter.com</a>.</td>
</tr>
<tr>
<td>Use MID server</td>
<td>Option to use a MID Server. If the check box is selected, define the fields in the Advanced MID Server Configuration related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. Click Update.

The Twitter spoke is set up and integrated with the ServiceNow instance.

**Zoom spoke v1.6.0**

The Zoom spoke helps you create and manage meetings. Add participants, retrieve details, end or delete a meeting. Use the spoke to fetch the participant details of a conference.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

IntegrationHub subscription

This spoke requires the IntegrationHub Starter subscription package. For more information, see Request IntegrationHub.

Supported versions

Zoom API version v2.0.

Spoke flows

This spoke has no sample flows.

Spoke subflows

This spoke has no sample subflows.

Spoke actions

The Zoom spoke provides actions to automate Zoom tasks when events occurs in the Now Platform. Available actions include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud Recording Management</td>
<td>Get Meeting Recordings</td>
<td>Retrieves all the recorded meeting for the specified meeting ID.</td>
</tr>
<tr>
<td></td>
<td>Look up Recordings</td>
<td>Lists all the recorded meetings of the specified user.</td>
</tr>
<tr>
<td>Meeting Management</td>
<td>Create Meeting</td>
<td>Create a meeting for a user using their Zoom user ID or the email address.</td>
</tr>
<tr>
<td></td>
<td>Delete Meeting</td>
<td>Delete a specific meeting by using its meeting ID</td>
</tr>
<tr>
<td></td>
<td>Get Meeting Details</td>
<td>Get details of a specific meeting by its meeting ID</td>
</tr>
<tr>
<td></td>
<td>Look Up Live Meetings by User [Data Stream]</td>
<td>Lists all the live or ongoing meetings for a specific user.</td>
</tr>
<tr>
<td></td>
<td>Look up Ended Meeting Instances</td>
<td>Lists all the meeting instances that were ended.</td>
</tr>
<tr>
<td>Category</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Add Meeting Registrant</td>
<td>Register a participant for a specific meeting.</td>
</tr>
<tr>
<td></td>
<td>End Meeting</td>
<td>Ends an ongoing meeting.</td>
</tr>
<tr>
<td>User Management</td>
<td>Look Up Users [Data Stream]</td>
<td>Lists all the users on your Zoom account.</td>
</tr>
<tr>
<td></td>
<td>Get User Details</td>
<td>Get details of a specific user on your account with their user ID.</td>
</tr>
</tbody>
</table>

**Zoom account requirements**

The Zoom spoke requires configuring your Zoom account to generate an OAuth 2.0 token.

**Zoom spoke requirements**

These actions use REST calls, which can run on an instance or Zoom spoke. Use the connection record associated with the Zoom alias to configure where actions run as well as set Zoom spoke selection attributes.

**Connection and credential alias requirements**

IntegrationHub uses aliases to manage connection and credential information. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. If the connection or credential information changes, you don't need to update any actions that use the connection. For more information, see Credentials and connection information.

This spoke uses the Zoom Connection & Credential Alias record to authorize actions.

**Setup Zoom spoke**

Integrate your Zoom account with your ServiceNow instance. Create a custom OAuth application in Zoom and authenticate requests from ServiceNow.

Role required: admin

- Request IntegrationHub subscription
- Activate Zoom spoke

*Create a connected app in Zoom*

Create a connected app in your Zoom account to enable OAuth 2.0 authentication with the Zoom spoke

1. Zoom account
2. Role required: Zoom admin

Complete the following steps from your Zoom account to enable OAuth 2.0 authentication with the Zoom spoke.

1. Login to Zoom marketplace
2. Navigate to Develop > Build App
3. Choose OAuth card from the available cards.
4. Use the toggle button to disable the option: **Would you like to publish this app on Zoom App Marketplace?**

5. Click **Create**.

6. Name the app and choose the app type as **Account-level app**. Account level apps must be installed by admin and can manage all users in the account.

7. Optionally, in the subsequent screens, enter the details as appropriate. For example, basic information, description and so on.
8. In the **Add Scopes** screen, add the actions in the scope as in the screenshot.

![Add scopes screen](image)

- **View and manage sub account's user meetings**
  - meeting:master
- **View all user meetings**
  - meeting:read:admin
- **View and manage all user meetings**
  - meeting:write:admin
Add scopes

- Meeting
- Webinar
- Recording
- User
  - Account
  - Billing
  - Contacts
  - Dashboard
  - Group
  - Devices (H323)

- View and manage sub account’s user information
  user:master
- View all user information
  user:read:admin
- View users information and manage users
  user:write:admin

**Note:** The next step is to register Zoom as an OAuth provider. However, ServiceNow ships Zoom as a registered OAuth provider in the Application Registry.

Record the **Client ID** and the **Client Secret** from the App credentials screen to use them for the application registry.

**Register Zoom as OAuth provider**

Use the information generated during Zoom account configuration to register Zoom spoke as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Role required: admin

1. Navigate to **System OAuth > Application Registry**.
2. Click **Zoom**.
3. On the form, fill in the fields.

### Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client ID created during application registration.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client secret created during application registration.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>Time, in seconds, that the refresh token is valid. This is set to 473,040,000 seconds.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>OAuth callback endpoint. Enter https://&lt;instance-name&gt;.service-now.com/oauth_redirect.do</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option to use mutual authentication for token request and revocation. Specify the profile for the mutual authentication.</td>
</tr>
<tr>
<td>Send Credentials</td>
<td>Client credentials in the request.</td>
</tr>
</tbody>
</table>

4. Right-click the form header, and click **Save**.

The instance can request OAuth 2.0 tokens for the spoke.

*Create credential records for the Zoom spoke*

Create Credential records for the Zoom connected app you created. The Zoom spoke connection and credential alias uses these credentials to authorize actions.

Role required: admin, Zoom admin

1. Navigate to **Connections & Credentials > Credentials**.
2. Click **New**.
   
   The system displays the message **What type of Credentials would you like to create?**.
3. Select **OAuth 2.0 Credentials**.
   
   The pop-up window displays a blank OAuth 2.0 Credentials form.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. Enter <strong>Zoom Credentials</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the credential record.</td>
</tr>
<tr>
<td>OAuth Entity Profile</td>
<td>OAuth profile you created when you registered the Zoom connected app as an OAuth provider. Select <strong>Zoom default_profile</strong>.</td>
</tr>
<tr>
<td>Applies to</td>
<td>MID Servers that can use this credential. Select <strong>All MID Servers</strong>.</td>
</tr>
<tr>
<td>Order</td>
<td>Order to apply this credential. Enter <strong>100</strong>.</td>
</tr>
</tbody>
</table>

5. Save the record.
6. Click the **Get OAuth Token** related link to generate the OAuth token.

*Create connection records for the Zoom spoke*

Create Connection records to your Zoom account. The Zoom spoke connection and credential alias uses these connections to perform actions in Zoom.
Role required: admin

1. Navigate to **Connections & Credentials > Connection & Credential Aliases**.
2. Open for the record for **Zoom**.
3. From the **Connections** tab, click **New**.
   The system displays a blank HTTP(s) Connection form.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the connection record. Enter <strong>Zoom Connection</strong>.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential record you created for Zoom. Select <strong>Zoom Credentials</strong>.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Alias record associated with this connection.</td>
</tr>
<tr>
<td>URL builder</td>
<td><img src="note.png" alt="Note: Do not select the check box." /></td>
</tr>
<tr>
<td>Connection URL</td>
<td>Base URL to connect to your Zoom instance. Enter <strong><a href="https://api.zoom.us">https://api.zoom.us</a></strong></td>
</tr>
<tr>
<td>Use MID Server</td>
<td>Option to use a MID Server. Define the fields in the Advanced MID Server Configuration related list if you select this option.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to actively use the connection.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the action or activity runs in.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click **Save**.

**Data Stream actions and pagination**

Send REST or SOAP requests from Flow Designer to APIs that return a stream of response data larger than 10 MB, or that return paginated results. Parse stream data into a series of complex object outputs and use the data pills in other actions in a flow.

For example, create a Data Stream action to import a large quantity of employee data from a third-party HR site. The Data Stream action sends a REST request to the third-party site and processes the response to populate records in the User [sys_user] table.

**Benefits**

Data Stream actions offer these benefits.

- Parse and format a stream of response data larger than 10 MB.
- Automatically send multiple requests to APIs that paginate results.
- Enable flow designers to process large requests without complex coding or configuration.
- Enable flow designers to process each object within a data stream using **For each** flow logic. For example, you might create a Data Stream action that imports document data from a third-party site. When you add the action to a flow, Flow Designer automatically adds the action to a **For each** flow logic block, enabling flow designers to easily create a record in ServiceNow for each object in the data stream. See **Use a Data Stream action in a flow**.
Limitations

Use Data Stream actions with these limitations in mind.

- Running a Data Stream action on a MID Server is not currently supported.
- Nesting Data Stream actions is not supported.
- You cannot execute a Data Stream action from script. For example, you cannot use `FlowAPI.executeAction()` to run a Data Stream action.
- Adding actions with wait conditions to Data Stream For Each flow logic blocks is not supported. For example, you cannot use the Ask for Approval or Wait for Condition actions within Data Stream For Each flow logic.

Action outline

Data Stream actions follow a set structure. Follow prompts to add and remove steps from the action outline. You cannot manually add steps to a Data Stream action.
Note: Clearing an option in a configuration page removes the step from the Data Stream outline and deletes all data associated with the step.

Action Preprocessing

Use the Action Preprocessing category to run a preprocessing script before the action sends the initial API request. For example, validate action inputs or set default values. Preprocessing executes once per action, before the first API request.

Selecting this option adds a script step to the Data Stream action. For more information, see Script step. This is an optional Data Stream action component.

Request

Use the Request category to configure how the action sends API requests. The Request section executes once per page of results. Request components provide these configuration options.

Pagination Setup step

Request results in batches. Once one page of data is processed, the Data Stream action runs the request section again to return the next set of results. Use the pagination setup step to set up pagination options required by the API.

Note: For licensing purposes, each request counts as one transaction, including each request for the next page of results.

The value of the reserved, read-only \texttt{getNextPage} variable determines whether to request another page of results. As long as the \texttt{getNextPage} variable is true, the action continues to send requests for the next page.

This is an optional Request component.

Script step

Run a script before every request for the next page of results. Use this script for data validation and transformation when calling a paginated API. For example, generate a JSON payload for the next page request. Selecting this option adds a script step to the Data Stream action. For more information, see Script step.

This is an optional Request component.

REST or SOAP step

Send a REST or SOAP request to a third-party API. Select a data format to add an associated step to the Data Stream action. For more information, see REST step and SOAP step.

This is a mandatory Request component.

Parsing

Use the Parsing category to configure how the action separates data stream elements into complex data objects. Use the Splitter step to identify and separate items from an XML or JSON stream, and use the Script Parser step to transform each item into a complex object. The Parsing section executes once per item in the stream.
For more information about complex data, see Complex data. Parsing components provide these configuration options.

**Splitter step**

Identify the parent node in the response stream to map to a complex object. For example, identify a user element in an XML payload to create a complex object for each user in the response stream.

Select a splitter type to identify and separate repeated items in an XML or JSON data stream.

- **JSON**: Identifies objects in a stream of JSON data.
- **XML**: Identifies objects in an XML document.

This is a mandatory Parsing component.

**Script Parser step**

Use JavaScript and ServiceNow APIs to map items in the response stream to a complex object output represented by the `targetObject` global object. For example, map incident record elements identified in the splitter step to a complex object containing incident fields. If the data stream includes siblings to the item identified in the splitter step that you do not want mapped to a complex object, include conditions to exclude those items.

This is a mandatory Parsing component.

**Data Stream outputs**

When designing a Data Stream action, you must create a single output of type Object. The Script Parser step maps items in the stream to this object using the `targetObject` global object.

At runtime, the system splits and parses the stream of response data according to the Data Stream configuration. Each item in the stream maps to the complex object structure defined by the Script Parser step and the object output, resulting in a large series of complex objects. For more information about complex data, see Complex data.

**Design considerations**

Create Data Stream actions with these considerations in mind.

**Write pagination logic according to third-party requirements**

Evaluate and understand the format required by your third-party endpoint. For example, you may need to write a script that sets the read-only `getNextPage` variable to true as long as there is a `nextPage` token in the response. If the response does not contain the token, then set the variable to false. Access variables in script using bracket or dot notation. For example, `variables['getNextPage']`. This variable only accepts the Boolean data type. The default value is false.

**Convert pagination variable data types to perform math operations**

Pagination variables only support the string data type. To perform math operations, you must convert the value to an integer, perform any required operations, then convert it back to a string.

```javascript
variables['offset'] = (parseInt(variables['offset']) + parseInt(variables['limit'])).toString();
```

**Ensure that the pagination script has an end condition**
Avoid infinite loops in pagination requests by creating a condition that sets the `getNextPage` variable to false. Cancel any long-running flows. Always test Data Stream actions before using them in production.

**Do not add wait conditions to a Data Stream For Each logic block**

Actions that wait, for example the Wait For Condition action, result in an error when used in a Data Stream For Each logic block. For example, suppose that you add a Data Stream action to a flow that processes a stream of expense records. You want to request approval for expenses over a certain dollar amount. Using the Ask for Approval action within the Data Stream For Each flow logic block is not supported.

**Clear configuration page options carefully**

Clearing an option in a configuration page removes the step from the Data Stream outline and deletes all data associated with the step.

**MID Server support**

Data Stream actions are not currently supported on a MID Server and generate an error when run from a MID Server. Data Stream actions cannot contain REST or SOAP steps that run on a MID Server. To prevent a flow from switching environments multiple times between the MID Server and the instance, avoid adding Data Stream actions between actions that run on the MID Server. For more information about when an action runs on the MID Server, see Integration steps.

**Execution details**

View the configuration and runtime results for each item processed by a Data Stream action. Select a record number to see its configuration and runtime details. By default, the execution details include requests for the first 1000 items. To change the number of items in the execution details, update the `com.snc.process_flow.reporting.datastream.item.lastn` system property.
View an overview of the execution that includes this information.

- **Page count**: Number of pages returned by a paginated API.
- **Total item count**: Number of items in the response stream mapped to complex object outputs.
- **Error count**: Number of errors encountered.

### Page details

View runtime data for each step within the Data Stream action. Select a page to view runtime details for each request to a paginated API. By default, the execution details include requests for the first five pages. To change the number of requests in the execution details, update the `com.snc.process_flow.page.reporting.lastn` system property. Set the value to 0 to remove pages from the execution details and -1 to include all pages.

**Note:** Including all pages can affect performance and is not recommended.
Create a Data Stream action

Create a reusable action to process a stream of response data within a flow.

- Set up an application in Guided Application Creator to store Flow Designer content.
- Disable any conflicting business rules or workflows before creating an action.
- Role required: action_designer or admin

**Note:** Clearing an option in a configuration page removes the step from the Data Stream outline and deletes all data associated with the step.

Creating a custom application to contain your Flow Designer content enables you to deploy it using the application repository or the ServiceNow Store.

1. Navigate to **Flow Designer > Designer**.
2. Click the **Actions** tab and select **New Data Stream**.
3. Fill in the **Action Properties** and click **Submit**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of action.</td>
</tr>
<tr>
<td>Accessible From</td>
<td>Accessible from all application scoped or only within the specified application scope.</td>
</tr>
<tr>
<td>Category</td>
<td>Defined category within the application scope for an action.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the action.</td>
</tr>
<tr>
<td>Protection</td>
<td>Select whether the action is read-only. You can only select a value when you create the action in an application scope you own. The default value is None.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the action.</td>
</tr>
<tr>
<td>In-Flow Annotation</td>
<td>Help text that appears under the action title in Flow Designer to help flow designers understand what the action does when used in a flow.</td>
</tr>
</tbody>
</table>

An empty Data Stream action opens.

4. Define action inputs to make data available to the action steps.
   a) Select **+ Create Input** and complete the fields. For more information about action inputs, see **Action Designer**.
      Inputs are represented as data pills in the right-hand pane. You can add inputs to steps and outputs in the flow by dragging and dropping data pills.

5. Click **Action Preprocessing** in the Data Stream outline and configure the desired options.
   a) Select **Enable preprocessing script** to run a preprocessing script before the action sends the initial API request. For example, validate action inputs or set default values. Preprocessing executes once per action, before the first API request.
      Selecting this option adds a script step to the Data Stream action. For more information, see **Script step**.
6. Click Request in the Data Stream outline and configure the desired options.
   a) In the How will you get data field, select REST Step or SOAP step. Selecting an option adds the associated step to the Data Stream action. For more information, see REST step and SOAP step.
   b) Select Enable pagination to request results in batches. Once one page of data is processed, the Data Stream action runs the request section again to return the next set of results. This option adds a Pagination Setup step to the Data Stream outline.
   c) Select Run a script before each request to run a script before every request for the next page when calling a paginated API. For example, write a script to transform variable data types from the initial response before sending a request for the next page. Selecting this option adds a script step to the Data Stream action. For more information, see Script step.

   **Note:** Data Stream actions are not currently supported on a MID Server and generate an error when run from a MID Server. Data Stream actions cannot contain REST or SOAP steps that run on a MID Server.

7. Optional: If pagination is enabled, configure the Pagination Setup step.
   a) Create pagination variables. For example, if the third-party API takes a limit parameter in the request, create the limit variable and set the initial value to limit the number of results per page. The initial value is only used in the first request. getNextPage is a reserved, read-only variable. As long as the getNextPage variable is true, the action continues to send requests for the next page.
   b) In the Next Value From field, define how pagination variables receive a value for subsequent requests.
      Choose from:
      • **Script**: Write a Pagination Variables Script to define how variables are populated. Pagination variables only support the string data type. To perform math operations, you must convert the value to an integer, perform any required operations, then convert it back to a string.
      • **Response Body**: Use a value in the response from the previous request to populate the variable. If the response is JSON format, set Extract value using to JSONPath Expression and provide the path to the value in the Expression field. If the response is XML format, set Extract value using to XPath Expression and provide the path to the value.

In this example, the getNextPage variable is true until the nextOffset variable reaches the total count value returned in the API response header. As long as the getNextPage variable is true, the action continues to send requests for the next page. This example includes a common limit/offset
pagination configuration. The third-party APIs that your Data Stream action interacts with may use a page token or other method.

1. Pagination Setup step

<table>
<thead>
<tr>
<th>Name</th>
<th>Initial Value</th>
<th>Next Value From</th>
</tr>
</thead>
<tbody>
<tr>
<td>getNextPage</td>
<td>false</td>
<td>Script</td>
</tr>
<tr>
<td>limit</td>
<td>100</td>
<td>Script</td>
</tr>
<tr>
<td>offset</td>
<td>0</td>
<td>Script</td>
</tr>
</tbody>
</table>

Pagination Variables Script

```javascript
function paginate(variables, pageResponse) {
    var limit = parseInt(variables.limit);
    var totalCount = parseInt(pageResponse.response_headers['X-Total-Count']);
    var currentOffset = parseInt(variables.offset);
    var nextOffset = currentOffset + limit;
    if (nextOffset < totalCount) {
        variables.getNextPage = true;
        variables.offset = nextOffset.toString();
    } else {
        variables.getNextPage = false;
    }
}
```
Important: Avoid infinite loops in pagination requests by creating a condition that sets the getNextPage variable to false. Cancel any long-running flows. Always test Data Stream actions before using them in production.

8. Click Parsing in the Data Stream outline and configure the desired options.
   a) In the How will you identify each record field, select JSON/XML Splitter. This adds a Splitter step to the Data Stream outline.
   b) In the How will you parse each item into an object field, select Script Parser. This adds a Script Parser step to the Data Stream outline.

9. Configure the Splitter step. This step identifies the parent node in the response stream to map to a complex object. For example, identify a user element in an XML payload to create a complex object for each user in the response stream.
   a) In the Source Format field, select the format returned by the Request section.
      • JSON: Identifies objects in a stream of JSON data.
      • XML: Identifies objects in an XML document.
   b) In the Item Path field, define the absolute path to the object. For example, use $.result in JSON or /result in XML to separate a result object.

   Note: The system ignores XML namespaces.

If the REST step returns the following JSON content, you would enter $.response.result.companies as the item path to process each company object.

```json
{
    "response": {
        "result": {
            "companies": [
                {
                    "name": "company1"
                },
                {
                    "name": "company2"
                },
                {
                    "name": "company3"
                }
            ],
            "metadata": {
                "token": 1558666526
            }
        }
    }
}
```

If the REST step returns the following XML document, you would enter /response/result/companies/company as the item path to process each company object.

```xml
<response>
    <result>
        <companies>
            <company>
                <!-- company 1 info -->
            </company>
            <company>
```
10. In the Script Parser step, use JavaScript and ServiceNow APIs to map items in the response stream to a complex object output represented by the `targetObject` global object. For example, map incident record elements identified in the splitter step to a complex object containing incident fields. If the data stream includes siblings to the item identified in the splitter step that you do not want mapped to a complex object, include conditions to exclude those items.

An example script that parses a JSON response.

```javascript
(function parse(inputs, outputs) {
    var record = JSON.parse(inputs.sourceItem);
    outputs.targetObject.id = record.number;
    outputs.targetObject.name = record.short_description;
})(inputs, outputs)
```

An example script that parses an XML response.

```javascript
(function parse(inputs, outputs) {
    var xmlDoc = new XMLDocument(inputs.sourceItem, false);
    outputs.targetObject.id = xmlDoc.getNodeText("/result/number");
    outputs.targetObject.name = xmlDoc.getNodeText("/result/
    short_description");
})(inputs, outputs)
```

11. Create a complex object output.

   a) Select Outputs in the Action Outline and click + to create an output.

   b) Update the Label field to represent the object. For example, if the action parses a stream of company records, add the Company label.

   c) Update the Type field to Object. This is the complex object output represented by the `targetObject` global object in the Script Parser step.

   d) Add child fields to the complex object using the + icon.

   e) Make the name of each child field more user-friendly so that you can meaningfully refer to it in script. The value in the Name field is the internal name used in the Script Parser
step. For example, to refer to the City output in the Script Parser step, you would use `outputs.targetObject.city`.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>company</td>
<td>Object</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td>city</td>
<td>String</td>
<td></td>
</tr>
</tbody>
</table>

**Warning:** After saving the Data Stream action, you cannot change values in the **Name** field.

12. Click **Save**. Action Designer saves a draft of the action.

**Use a Data Stream action in a flow**

Data Stream actions use the **For each** flow logic option to process stream data in a flow. For example, suppose that you want to use a Data Stream action that imports document data from a third-party site. When added to a flow, the action appears as a **For each** flow logic block, enabling flow designers to easily create a record in ServiceNow for each object in the data stream.

Role required: flow_designer or admin

1. Open the flow you want to add the Data Stream action to.
2. Add the Data Stream action to the flow.

**Note:** Data Stream actions are not currently supported on a MID Server and generate an error when run from a MID Server. Data Stream actions cannot contain REST or SOAP steps that run on a MID Server. To prevent a flow from switching environments multiple times between the MID Server and the instance, avoid adding Data Stream actions between actions that run...
The action appears as a **For Each** flow logic block.

3. Add a child action within the **For Each** flow logic block. This action runs on each object within the data stream.

   **Note:** Adding actions with wait conditions to Data Stream For Each flow logic blocks is not supported. For example, you cannot use the Ask for Approval or Wait for Condition actions within Data Stream For Each flow logic.

4. Click **Save**.
Flow Designer saves a draft of the flow, trigger, and actions.

Test the flow until it is ready to be activated.

   **Note:** The system only triggers active flows.

**Integration steps**

Enable custom actions to integrate with external systems by activating IntegrationHub, which adds integration steps to the Action Designer interface.

Integration steps can run on the instance or a MID Server. A MID Server is required to communicate with or move data between a ServiceNow instance and external applications, data sources, and services in your network.
Steps that perform operations on record data run on the instance, while steps that integrate with systems in your network run on a MID Server. If a step requires a MID Server to run, the instance delegates flow processing to the appropriate MID Server by sending the process plan in a REST call. The MID Server executes the action or step in the process plan and returns results. View log messages and execution status from the instance or the MID Server.

**Available integration steps**

These integration steps are available from Action Designer.

<table>
<thead>
<tr>
<th>Integration step</th>
<th>Description</th>
<th>Step runs from</th>
</tr>
</thead>
<tbody>
<tr>
<td>JDBC step</td>
<td>Create a reusable action to send SQL commands to a relational database.</td>
<td>MID Server</td>
</tr>
<tr>
<td>Payload Builder step</td>
<td>Enable action designers to easily create name-value pairs in JSON and XML payloads using dynamic data.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Instance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MID Server</td>
</tr>
<tr>
<td>PowerShell step</td>
<td>Run PowerShell scripts on remote machines from your ServiceNow instance through a MID Server.</td>
<td>MID Server</td>
</tr>
<tr>
<td>REST step</td>
<td>Send an outbound REST web service request to an external system.</td>
<td>• Instance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MID Server</td>
</tr>
<tr>
<td>SOAP step</td>
<td>Enable action designers to send outbound SOAP web service requests to external systems.</td>
<td>• Instance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MID Server</td>
</tr>
<tr>
<td>SSH step</td>
<td>The SSH step executes SSH commands on an external &quot;nix system through a ServiceNow® MID Server. The step also stores scripts and commands for the &quot;nix systems.</td>
<td>MID Server</td>
</tr>
<tr>
<td>XML parser step</td>
<td>Identify structured data from an XML payload without having to write script. Map incoming XML elements to a complex object output that you can use in other steps or actions. At runtime, values from an XML payload populate the complex object output.</td>
<td>• Instance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MID Server</td>
</tr>
</tbody>
</table>

**Training**

Complete a step-by-step training on using the REST step in the REST in IntegrationHub developer training.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Connection attributes

Define connection-specific variables that you can use in IntegrationHub integration steps. When using an integration step, you must establish a connection with an external system. Use a Connection & Credential alias instead of defining the connection inline. An alias enables you to update the connection details once without having to reconfigure every action. Any action step that uses an alias inherits the attributes associated with it. Flow Designer displays attributes as data pills that you can drag into your action step. For example, you can create a page size attribute that becomes a REST step query parameter. For more information about connection attributes, see Create connection attributes for IntegrationHub.

MID Server connection aliases

Action designers can set MID Server selection attributes using a connection record associated with an alias and associate the alias with an integration step. When the flow runs, the system uses the attributes to determine which MID Server runs the step. Learn more about connection and credential aliases.

MID Server selection

Flow designers should avoid shifting the execution environment between MID Servers when a flow runs. Either configure your MID Servers to perform operations on multiple endpoints, or provide multiple capabilities to the MID Servers in your network. You may need a user with the connection_admin role to update the connection records associated with an action, or a network administrator to update the MID Server network configuration. To learn more about how a MID Server is selected during runtime, see MID Server selection.

Design considerations

Design integration steps using the following guidelines.

- Avoid shifting the execution environment between the instance and the MID Server multiple times. Where possible, group similar action steps. For example, group core steps that perform record operations and integration steps that run on the MID Server.
- When creating a spoke that uses an integration step, include a Connection and Credential alias record with the appropriate connection type. Before anyone can use the spoke, a user with the connection_admin role must associate the alias record to a connection record that supports the connection type. If defining the connection inline, use inputs to enable the process analyst to define the connection information when adding the action to a flow.
- The MID Server does not have access to all the values in a GlideRecord object, it only has access to the sys_id reference. Inputs of type Reference do not work on a MID Server. Instead, create action inputs that contain the necessary GlideRecord values.

Roles

To create integration steps, a user must have the action_designer or admin roles. If running steps on a MID Server, the MID Server user must have the connection_admin and credential_admin roles to access the connection and credential information associated with the step.

JDBC step

Create a reusable action to send SQL commands to a relational database.
Note:

- The JDBC step is not available in the base system and requires the subscription to IntegrationHub Standard Pack Installer (com.glide.hub.integrations.standard) or later. For more information about the ServiceNow® IntegrationHub subscription packages, see IntegrationHub usage and subscription. After the required plugin is activated, the step is visible under Integrations.
- The JDBC step runs only on a ServiceNow® MID Server with JDBC step capabilities. Activate the plugin, IntegrationHub Standard Pack Installer (com.glide.hub.integrations.standard) or later to use the JDBC capability for the MID Server.

Roles and availability

The JDBC step is available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Sanitizing inputs using the escape functions

Escape all user inputs to eliminate the possibility of a malicious user from executing malicious SQL statements, resulting in SQL injection on your target database. When you use data pills in JDBC step SQL statements, sanitize them first using a preprocessing Script step.

In the Script step, use the escape APIs, escapeSQLIdentifier and escapeSQLValue. These APIs are available as static methods of the server-side script class, SNC.GlideSQLEscapeUtils. For example,

```javascript
var escapedValue = SNC.GlideSQLEscapeUtils.escapeSQLValue("MYSQL", "Georgi's Birthday");
```

The escaped values from the escape APIs are the output of the Script step. Use this escaped output in the SQL statements of the JDBC step.

<table>
<thead>
<tr>
<th>Escape API</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>escapeSQLIdentifier</td>
<td>• Escapes special characters and injected values in the SQL identifiers.</td>
</tr>
<tr>
<td></td>
<td>• Validates input for a period character. Throws an SQLEscapeException error when a period character is encountered.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To join SQL identifiers using a period, use two pills, which are ID escaped, joined by the period.</td>
</tr>
<tr>
<td>escapeSQLValue</td>
<td>Escapes special characters and injected values in SQL values by wrapping the input in database-specific quotes.</td>
</tr>
</tbody>
</table>
Whitelisting SQL operations

By default, you can run the following SQL operations.

- SELECT
- INSERT
- UPDATE
- DELETE
- SHOW
- DESCRIBE

To enable only some of these SQL operations that the JDBC step can perform, create a MID Server property, `mid.property.jdbc_operations` and enter the whitelisted SQL operations, separated by comma. To learn more about MID Server properties, see MID Server properties.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Details</td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td>Connection</td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane. This field is available when <strong>Use Connection Alias</strong> is selected from the Connection list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credential Alias</td>
<td>Credential alias the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane. This field is available when <strong>Define Connection Inline</strong> is selected from the Connection list.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
**Database Type** | Database type for this connection. The choices are:
- MySQL
- Oracle
- SQLServer
- Custom

The default choice is **Custom**. This field is available when **Define Connection Inline** is selected from the Connection list.

**JDBC Driver** | Driver to use for this connection when it's not a default database type such as DB2 Universal and Sybase. The database type is **Custom**. This field is available when **Define Connection Inline** is selected from the Connection list and **Custom** is selected from the Database Type list.

**Connection URL** | URL that the MID Server uses to connect to the specified database. The URL is created automatically when you save the form, and is read-only for the default databases. This field is available when **Define Connection Inline** is selected from the Connection list and **Custom** is selected from the Database Type list.

**MID Application** | Application that the MID Server must support to be eligible for selection. This field is available when **Define Connection Inline** is selected from the Connection list.

**Capabilities** | Capability of the MID Server. Select **JDBC**. This field is available when **Define Connection Inline** is selected from the Connection list.

**Connection Timeout** | Maximum elapsed time, in seconds, for the activity to wait while attempting to connect to the target database. This field is available when **Define Connection Inline** is selected from the Connection list.

**Query Timeout** | Maximum elapsed time, in seconds, that the query is allowed to run without a response. This field is available when **Define Connection Inline** is selected from the Connection list.

**JDBC Configuration**

**SQL Statement** | SQL statement that the step executes.

**Note:** When you use data pills in step SQL statements, sanitize them first using a preprocessing Script step. For more information, see Sanitizing inputs using the escape functions.

**Maximum Rows** | Maximum number of rows to be returned from the SQL statement. The default value is 1000.

**Maximum Payload Size (KB)** | Maximum allowable payload size, in KB, to be returned from the SQL statement. The default payload size is 5120 KB. The maximum payload size is 5 MB.

**Retry Policy**

**Enable Retry Policy** | Option to enable the retry policy. For more information, see Retry policy.

**Override Default Policy for Alias** | Option to override the default retry policy. This option is not applicable when **Define Connection Inline** is selected from the Connection list.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
</tbody>
</table>

**Test JDBC step**

Test the JDBC step before testing or publishing an action that contains the JDBC step.

It is mandatory that you test the JDBC step before testing the action. Testing ensures that the relevant complex object output schema is created from table columns, which can be used as data pills in subsequent steps.

1. Navigate to Flow Designer > Designer.
2. Create an action with a JDBC step.
3. Click Test JDBC Step. The Test JDBC Step pop-up window is displayed.
4. If the JDBC step takes an action input or output of the previous step as its input, provide required input values in the Step input pills field to test the JDBC step.

| Note: Input values in the Step input pills fields are not needed when records are updated, inserted, or deleted. |

5. Click Run Test.
   - When a SELECT query is executed, Sample Result is displayed in the Test JDBC Step pop-up window. Sample Result includes column names, columns types, and the values of the first row.
   - When an UPDATE, INSERT, or DELETE query is executed, a message is displayed mentioning the number of rows affected.

6. To use the sample result as the JDBC step output, click Use Result.

| Note: Use Result is not displayed when records are updated, inserted, or deleted. |

7. To retrieve schema of a different table when a SELECT query is executed in the JDBC step, enter the required value in the Step input pills field and click Run Test.

When a SELECT query is executed in the JDBC step, ResultSet is displayed under Outputs. The relevant complex object output is populated. To learn more about complex objects, see Complex data.

Test and publish the action.

**Payload Builder step**

Enable action designers to easily create name-value pairs in JSON and XML payloads using dynamic data.

**Roles and availability**

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.
### Fields

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name Value Pairs    | The name-value pairs to include in the payload. Click the plus icon to add name-value pairs. Drag data pills into either field to produce dynamic payloads. The **Name** becomes a key in JSON and an element in XML. For example, suppose you create this name-value pair.  
- **Name**: short_description  
- **Value**: [action]->[short_description]  
  When the system formats the name-value pair as JSON:  
  "short_description": "[action]->[short_description]"  
  When the system formats the name-value pair as XML:  
| Omit if empty       | The option to exclude a name-value pair if the value is empty or null.  
  **Note**: This field is only visible after clicking the down arrow to display advanced options. |
| Output Format       | The payload file format.  
- **JSON**: Select to format the payload as a JSON document.  
- **XML**: Select to format the payload as an XML document. |
| Namespace           | The XML namespace to apply to each element. For example, when the namespace is set to **incident**:  
  **Note**: This field is only visible when the **Output Format** is set to XML. |
<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Outer Structure</td>
<td>The option to include or exclude a top level container appropriate to the output format. When the <strong>Output Format</strong> is JSON, curly braces contain the name-value pairs. When the <strong>Output Format</strong> is XML, a specified XML element contains the name-value pairs. For example, when the system formats the name-value pair as JSON:</td>
</tr>
<tr>
<td></td>
<td>{ &quot;short_description&quot;: &quot;[action]-&gt;[short_description]&quot; }</td>
</tr>
<tr>
<td></td>
<td>When the system formats the name-value pair as XML:</td>
</tr>
<tr>
<td></td>
<td>&lt;xml&gt;&lt;short_description&gt;[action]-&gt;[short_description]&lt;/short_description&gt;&lt;/xml&gt;</td>
</tr>
<tr>
<td>Send Empty Structure</td>
<td>The option to send valid JSON or XML structures when the payload is empty. Enable this option to include JSON or XML structural text in the payload. For example, when the system formats an empty structure as JSON:</td>
</tr>
<tr>
<td></td>
<td>{}</td>
</tr>
<tr>
<td></td>
<td>When the system formats an empty structure as XML:</td>
</tr>
<tr>
<td></td>
<td>&lt;xml&gt;&lt;/xml&gt;</td>
</tr>
<tr>
<td></td>
<td>Disable this option to produce an empty payload. Empty payloads can occur when you select the <strong>Omit if empty</strong> option for every name-value pair, and all name-value pairs in the payload produce empty values.</td>
</tr>
<tr>
<td>Parent Node</td>
<td>The name of the XML element that contains the name-value pairs. The default parent node element is <code>xml</code>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when the <strong>Output Format</strong> is set to <strong>XML</strong> and the option to <strong>Include Outer Structure</strong> is enabled.</td>
</tr>
<tr>
<td>Preview</td>
<td>The read-only payload the step produces.</td>
</tr>
</tbody>
</table>
PowerShell step

Run PowerShell scripts on remote machines from your ServiceNow instance through a MID Server. PowerShell is built on the Windows .NET Framework and is designed to control and automate the administration of Windows machines and applications. ServiceNow supports PowerShell 2.0 and above. PowerShell 3.0 does not support Windows 2003 Server.

Note: PowerShell step is not available in the base system and requires the ServiceNow® IntegrationHub subscription. After the required plugin is activated, the step is visible under Integrations.

Roles and availability

• Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see <a href="#">credentials, connections, and aliases</a>.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see <a href="#">credentials, connections, and aliases</a>. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when the Connection is <strong>Use Connection Alias</strong>.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Credential Alias    | Credential alias the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane.  

Note: This field is only visible when the Connection is Define Connection Inline. |
| Host                | Specify the fully-qualified domain name of the target host where the system runs the action step. For example, host.domain.com.  

Note: This field is only visible when the Connection is Define Connection Inline. |
| Port                | Specify the communications port on which the target host listens for connections. For example, 5985. Leave blank to use the default port.  

Note: This field is only visible when the Connection is Define Connection Inline. |
| MID Application     | Specify the application the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected application. If you use a data pill for this field, the pill must reference the MID Application's name, not the MID Application record.  

Note: This field is only visible when the Connection is Define Connection Inline. |
| Capabilities        | Specify the capabilities the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected capabilities.  

Note: This field is only visible when the Connection is Define Connection Inline. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remoting Type</td>
<td>The location where the PowerShell script runs such as the MID or a remote server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Explicit Remoting (Most Common):</strong> Establish a connection with and run the script on a remote server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Implicit Remoting (Advanced):</strong> Run a script on a MID Server while importing necessary modules from a remote server. If selected, define the <strong>Remote name prefix</strong> and <strong>Modules to import</strong> fields. For optimal performance, only import modules necessary to the step. If blank, all available modules are imported from the server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Run on a MID Server or have your script establish a remote session:</strong> Run a script directly on a MID Server, or define remoting specifications within the script. This value is the default.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To invoke a function in a PowerShell script command or PowerShell script file, the command must define the function param block if the function has input parameters. This requirement applies to explicit and implicit remoting. For additional information on param block, see Microsoft's documentation on Windows Powershell parameters at <a href="https://technet.microsoft.com/">https://technet.microsoft.com/</a>.</td>
</tr>
<tr>
<td>Remote name prefix</td>
<td>The file path, excluding file names, to the modules to load from the remote server.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when the Remoting Type is <strong>Implicit Remoting (Advanced)</strong>.</td>
</tr>
<tr>
<td>Modules to import</td>
<td>The comma-separated list of modules to import from the remote server at the defined file path.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only visible when the Remoting Type is <strong>Explicit Remoting (Most Common)</strong> or <strong>Implicit Remoting (Advanced)</strong>.</td>
</tr>
<tr>
<td>Script type</td>
<td>The type of script to run on the PowerShell host.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Inline script:</strong> Enter the script to run in the <strong>Command</strong> field of the step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>MID Server Script File:</strong> Select the PowerShell script to run from the MID Server Script Files [ecc_agent_script_file] table. This is the default value and separates scripting logic from the action, enabling you to update the script without having to modify and redeploy the action.</td>
</tr>
<tr>
<td>MID Server Script</td>
<td>Pre-defined PowerShell script from the MID Server Script Files table [ecc_agent_script_file].</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only available if the <strong>Script type</strong> is <strong>MID Server Script File</strong>.</td>
</tr>
</tbody>
</table>
### PowerShell scripting variables

To access input variables from the **Command** field, you must call them using special syntax. The syntax you use depends on the value of a system property. If the **Remoting Type** is Run on a MID Server or have your script establish a remote session, some reserved variables are available in addition to input variables.

#### Input variable syntax

By default, prefix variable names with a $ character. For example, if an input variable is named `message`, use `$message` to access the variable in script.

If the `mid.powershell.command.script.parameter_passing` parameter is set to false, prefix the variable name with `$env:SNC_`. For example, if an input variable is named `message`, use `$env:SNC_message` to access the variable in script. To learn more about the `mid.powershell.command.script.parameter_passing` parameter, see MID Server parameters.

#### Reserved variables

When the **Remoting Type** is Run on a MID Server or have your script establish a remote session, the following variables are available for use in script. Reserved variables cannot be used as custom input variable names.

<table>
<thead>
<tr>
<th>Reserved variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$computer</td>
<td>Host IP address defined in the Connection alias record.</td>
</tr>
<tr>
<td>$cred</td>
<td>Credential object that contains the credentials defined in the connection record. Use this variable with any PowerShell cmdlet that supports the credential parameter. For example, <code>New-PSSession -credential $cred</code>.</td>
</tr>
</tbody>
</table>
Reserved variable | Description
--- | ---
$log_info | If the `mid.property.powershell.log_info` property is set to true, adds logging information to a PowerShell script.

The following variable names are reserved for internal processing and should not be used as input variables.

- script
- useCred
- isMid
- isDiscovery
- debug
- user
- password
- executingScriptDirectory
- midScriptDirectory
- hresult

REST step

Send an outbound REST web service request to an external system.

**Note:** REST step is not available in the base system and requires the ServiceNow® IntegrationHub subscription. After the required plugin is activated, the step is visible under Integrations.

Outbound REST web service is a platform feature that allows you to retrieve, create, update, or delete data on a web services server that supports the REST architecture.

Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>The type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
</tbody>
</table>

To learn more about connections and credentials, see credentials, connections, and aliases.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Connection Alias    | Connection & Credential alias record the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane.  
  
  **Note:** This field is only visible when the Connection is Use Connection Alias.                                                                                                                                                                                                                     |
| Credential Alias    | Credential alias the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane.  
  
  **Note:** This field is only visible when the Connection is Define Connection Inline.                                                                                                                                                                                                                       |
| Use MID             | The option to use a MID Server to run the REST step. Select this option to display the MID Application and Capabilities fields.                                                                                                                                                                                                                               |
| Base URL            | The base URL for the REST request. If Use Connection Alias is selected, this field is read-only and displays the base URL associated with alias. If Define Connection Inline is selected, enter a base URL for the connection.                                                                                                                                                                                             |
| MID Application     | Specify the capabilities the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected capabilities.                                                                                                                                                                                                                       |
| Capabilities        | Specify the capabilities the MID Server must support to be eligible for selection. The system runs the action step from a MID Server that supports the selected capabilities.                                                                                                                                                                                                                       |
| Build Request       | Create the request manually, or import an OpenAPI Specification.  
  
  • **Manually:** Create action inputs and complete the REST step form manually.  
  
  • **From OpenAPI specification:** Import an OpenAPI Specification to generate action inputs and complete the REST step form. For more information, see OpenAPI support in the REST step.                                                                                                                                 |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| API Source    | Select an OpenAPI Specification used to construct the request, or select Import OpenAPI to import a new OpenAPI Specification. You can import specifications by providing a URL to the YAML or JSON, or copying and pasting content.  

**Note:** This field is only visible when Build Request is set to From OpenAPI specification. |
| API Operation | Select an operation from the list. Available operations are provided by the OpenAPI Specification in the API Source field.  

**Note:** This field is only visible when Build Request is set to From OpenAPI specification. |
| Resource Path | Specify the path for the resource.                                                                                                                                 |
| HTTP Method   | Specify the HTTP method to process the request.  

- GET  
- POST  
- PUT  
- PATCH  
- DELETE  |
| Query Parameters | Specify the name-value pairs to pass to the REST endpoint. You can create these parameters manually, or drag input variables into the parameter fields, and then assign a value.  

**Note:** When importing an OpenAPI Specification, the system adds all parameters and headers present in the specification to the REST step. Review the final REST step values and remove parameters you do not want to send in the request. For example, if the API accepts content type headers for both JSON and XML, the system adds both headers to the REST step. You must remove one depending on the content type you want to receive in the response. |
| Headers       | Specify the headers to send with the request. You can create headers manually, or drag input variables into the parameter fields, and then assign a value.  

**Note:** When importing an OpenAPI Specification, the system adds all parameters and headers present in the specification to the REST step. Review the final REST step values and remove parameters you do not want to send in the request. For example, if the API accepts content type headers for both JSON and XML, the system adds both headers to the REST step. You must remove one depending on the content type you want to receive in the response. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request Type</td>
<td>Specify the format of the request. Options include.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Text</strong>: A request in JSON, XML, or other text format.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Binary</strong>: A request in a binary file format.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Multipart</strong>: A request consisting of multiple content types.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Form URL-Encoded</strong>: A request in a URL-encoded query.</td>
</tr>
<tr>
<td>Note</td>
<td>This field is only editable when the HTTP Method is POST, PUT, PATCH, or DELETE.</td>
</tr>
<tr>
<td>Request Body [Text]</td>
<td>Enter the body of the request in JSON or XML format. The flow execution details display the response body as either a link to the embedded text viewer or the Sys ID of the attachment record containing the response.</td>
</tr>
<tr>
<td>Note</td>
<td>This field is only editable when the Request Type is Text.</td>
</tr>
<tr>
<td>Attachment</td>
<td>Specify the Attachment record containing the request. You can look up this record in a prior step or define it as an input variable.</td>
</tr>
<tr>
<td>Note</td>
<td>This field is only visible when the Request Type is Binary.</td>
</tr>
<tr>
<td>Name, Type, Value</td>
<td>Specify the content of a multiple part request. For each request part, specify its name, content type, and value. The name can be any valid string and the type can be any valid type. The value must match the content type.</td>
</tr>
<tr>
<td></td>
<td>For attachments, specify:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: attachment</td>
</tr>
<tr>
<td></td>
<td>• <strong>Value</strong>: The Sys ID of the Attachment record containing the content.</td>
</tr>
<tr>
<td></td>
<td>You can look up this record in a prior step or define it as an input variable.</td>
</tr>
<tr>
<td>Note</td>
<td>These fields are only visible when the Request Type is Multipart.</td>
</tr>
<tr>
<td>Name, Value</td>
<td>Specify the content of a form URL-encoded request. Specify each part of the URL-encoded request with a name-value pair.</td>
</tr>
<tr>
<td>Note</td>
<td>These fields are only visible when the Request Type is Form URL-Encoded.</td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to enable the retry policy. For more information, see Retry policy.</td>
</tr>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This option is not applicable when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
</tbody>
</table>
### REST response size limits

By default, the system limits the size of REST responses that are not saved as attachments to 5 MB. Direct REST responses that exceed this limit generate an error. To support larger response sizes, either save the response as an attachment or increase the response size limit with the `glide.pf.rest.response_payload_max_size` system property. This system property supports a maximum value of 10 MB.

### OpenAPI support in the REST step

Populate REST step fields and action inputs with information imported from an OpenAPI Specification. Import specifications by providing a URL to the YAML or JSON, or copying and pasting content.

**Benefits**

OpenAPI support in the REST step offers these benefits.

- Use information imported from an OpenAPI Specification to configure REST step operations, HTTP methods, parameters, request body, path, and headers.
- Review available API operations without leaving the Flow Designer interface.
- Generate inputs required for the REST step to send valid requests to an OpenAPI service and add them to the REST step in the correct location.

**Note:** Always review REST step values imported from an OpenAPI Specification before sending a request. Remove parameters, headers, and inputs that the API does not require.

### Generated inputs

When you import an OpenAPI Specification, the system creates any required inputs and adds them to the REST step form where appropriate. At runtime, the system sends a REST request that contains input...
values provided to the action. For example, if an API requires a name parameter passed in the request, the system creates a name input and adds it to the REST step. When you add the action to the flow, name becomes an input to the action.

The system maps OpenAPI data types to Flow Designer data types. For example, if the OpenAPI Specification requires a user object, then the system creates a complex data object as input. For more information, see Complex data.

**Specification size limit**

By default, the system can import OpenAPI Specifications up to 10 MB. To increase the import size, update the glide.rest.openapi.max_request_size system property. The maximum value is 100 MB.

**Specification management**

Import an OpenAPI Specification by selecting options in the REST step. For more information, see REST step. Importing an OpenAPI Specification creates a record in the OpenAPIs [sys_openapi] table. You can view or delete specification records directly from this table. To update a specification, delete it and import it again.

**Design considerations**

Create a REST step from an OpenAPI Specification with these considerations in mind.

**Remove unnecessary REST step parameters**

When importing an OpenAPI Specification, the system adds all parameters and headers present in the specification to the REST step. Review the final REST step values and remove parameters you do not want to send in the request. For example, if the API accepts content type headers for both JSON and XML, the system adds both headers to the REST step. You must remove one depending on the content type you want to receive in the response.

**Make input labels user-friendly**

Ensure that input labels required for the REST step are clear and understandable. Clear labels enable flow designers to easily understand the required inputs when using the action in a flow.

**Remove inputs that do not require flow designer configuration**

When importing an OpenAPI Specification, the system adds all inputs present in the specification to the action input section. Remove any inputs that do not require a flow designer to configure. For example, if a REST step variable receives a value from another step in the action, an action input is not required.

**Avoid changing the API operation**

Changing the value of the API Operation field removes all values dependent on that operation. If you configure the OpenAPI Specification values in the REST step form, then change the operation, the system does not save your configuration. Values that are entered manually by a user are not affected.

**Limitations**

Create a REST step from an OpenAPI Specification with these limitations.

**Request body media types**
The request body only supports JSON and XML-based media types. If the selected operation from the imported OpenAPI Specification contains a request body with a different media type, the system adds a data pill of type String to the **Request body** field.

**OpenAPI 3.0 components**

OpenAPI 3.0 adds new components to Swagger 2.0 to describe an API in further detail. OpenAPI support in the REST step supports some, but not all of these components. The REST step does not currently support these components.

- Schema Object: oneOf, anyOf properties
- Discriminator Object
- Info object: termsOfService, contact, license fields
- Example Object
- Link Object
- Callback Object
- Security Scheme Object
- Security Requirements Object
- Tag Object
- External Documentation Object
- Server Object
- Specification extensions
- Recursive references

More information on these components is available in the OpenAPI documentation. See [OpenAPI Specification](#).

**SOAP step**

Enable action designers to send outbound SOAP web service requests to external systems.

**Note:** SOAP step is not available in the base system and requires the ServiceNow® IntegrationHub subscription. After the required plugin is activated, the step is visible under Integrations.

**Roles and availability**

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.
- Action designers need the web_service_admin role to perform these web services tasks.
  - Select WSDL
  - Load new WSDL
  - Select a WS-Security policy
- The MID Server does not support WS-Security policies

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Details</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connection</td>
<td>The type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see <a href="#">credentials, connections, and aliases</a>.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see <a href="#">credentials, connections, and aliases</a>. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when the <strong>Connection</strong> is <strong>Use Connection Alias</strong>.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see <a href="#">credentials, connections, and aliases</a>. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when the <strong>Connection</strong> is <strong>Define Connection Inline</strong>.</td>
</tr>
<tr>
<td>Use MID</td>
<td>The option to use a MID Server to run the SOAP step. Select this option to display the <strong>MID Application</strong> and <strong>Capabilities</strong> fields.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Endpoint</td>
<td>The URL endpoint for the SOAP request. If <strong>Use Connection Alias</strong> is selected, this field is read-only and displays the endpoint URL associated with alias. If <strong>Define Connection Inline</strong> is selected, enter a endpoint URL for the connection.</td>
</tr>
<tr>
<td>Request Details</td>
<td></td>
</tr>
<tr>
<td>Build Envelope</td>
<td>The method to use when building the SOAP envelope.</td>
</tr>
<tr>
<td></td>
<td>• <strong>From WSDL</strong>: Select this option to display the <strong>Select a WSDL</strong> and <strong>Operation</strong> fields.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Manually</strong>: Select this option to manually enter or paste WSDL text.</td>
</tr>
<tr>
<td>Select a WSDL</td>
<td>The WSDL to use to build the SOAP envelope. Select an existing WSDL record or click <strong>Load New WSDL</strong> to download or manually enter a WSDL file. The selected WSDL populates the values of the <strong>Operation</strong>, <strong>SOAP action</strong>, and <strong>SOAP Envelope</strong> fields.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when <strong>Build Envelope</strong> is set to <strong>From WSDL</strong>.</td>
</tr>
<tr>
<td>Load New WSDL</td>
<td>The option to download or manually enter a WSDL file.</td>
</tr>
<tr>
<td>Operation</td>
<td>The operation to run from the selected WSDL. Each WSDL has its own list of available operations.</td>
</tr>
<tr>
<td>SOAP Action</td>
<td>The URL to run the SOAP action. If <strong>Build Envelope</strong> is set to <strong>From WSDL</strong>, this field is read-only and displays the URL to run SOAP action. If <strong>Build Envelope</strong> is set to <strong>Manually</strong>, enter a URL to run the SOAP action.</td>
</tr>
<tr>
<td>SOAP Envelope</td>
<td>The XML text sent to the endpoint. If <strong>Build Envelope</strong> is set to <strong>From WSDL</strong>, the system adds the necessary XML for the <strong>Operation</strong> you select. If <strong>Build Envelope</strong> is set to <strong>Manually</strong>, enter the XML text you want to use. Enter record values in the appropriate SOAP envelope elements. For example, enter an incident short description in the <code>&lt;short_description&gt;</code> element.</td>
</tr>
<tr>
<td>Reset Envelope</td>
<td>The option to discard all manual changes you made to the SOAP envelope. Select this option to revert the SOAP envelope to its original state.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This option is only active when <strong>Build Envelope</strong> is set to <strong>From WSDL</strong>.</td>
</tr>
<tr>
<td>New WSDL</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>The name of WSDL record you want to create.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Import Method</td>
<td>The method to enter WSDL.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Download from URL</strong>: Select to display the WSDL URL, User name, and Password fields to retrieve the WSDL from an external source, typically the web service provider.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Manually Populate WSDL Content</strong>: Select to display the WSDL Content field to manually enter or paste WSDL text.</td>
</tr>
<tr>
<td>WSDL URL</td>
<td>The URL to the SOAP web service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when the Import Method is set to Download from URL.</td>
</tr>
<tr>
<td>User name</td>
<td>The user name to authenticate with the SOAP web service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when the Import Method is set to Download from URL.</td>
</tr>
<tr>
<td>Password</td>
<td>The password to authenticate with the SOAP web service. The system always masks passwords in the user interface and prevents exporting them as plain text.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when the Import Method is set to Download from URL.</td>
</tr>
<tr>
<td>WSDL Content</td>
<td>The XML document describing the SOAP web service and its operations.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is only visible when the Import Method is set to Manually Populate WSDL Content.</td>
</tr>
<tr>
<td>Import</td>
<td>The option to add the SOAP web service WSDL to the instance.</td>
</tr>
<tr>
<td>WS-Security</td>
<td></td>
</tr>
<tr>
<td>Enable WS-Security Policy</td>
<td>The option to restrict the SOAP web service to a security policy. Select to display the Policy field.</td>
</tr>
<tr>
<td>Policy</td>
<td>The policy record you want to use to restrict web service connections. Select an existing policy record.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td></td>
</tr>
<tr>
<td>Enable Retry Policy</td>
<td>Option to enable the retry policy. For more information, see Retry policy.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Override Default Policy for Alias</td>
<td>Option to override the default retry policy. This option is not applicable when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Retry Policy</td>
<td>Default retry policy associated with Connection Alias. If Override Default Policy for Alias is selected, you can override the default retry policy and select another existing retry policy based on your requirement.</td>
</tr>
<tr>
<td>Advanced Options</td>
<td></td>
</tr>
<tr>
<td>Headers</td>
<td>The name-value pairs to include in the SOAP message as HTTP headers. Click the plus icon to add headers. Add a Name and Value for each HTTP header.</td>
</tr>
<tr>
<td>Omit if empty</td>
<td>The option to exclude a name-value pair if the value is empty or null.</td>
</tr>
</tbody>
</table>

**Note:** This field is only visible after clicking the down arrow to display advanced options.

### SOAP response size limit

The system limits the size of SOAP responses to 5 MB. Direct SOAP responses that exceed this limit generate an error. To support larger response sizes, increase the response size limit with the glide.pf.soap.response_payload_max_size system property. This system property supports a maximum value of 10 MB.

### SSH step

The SSH step executes SSH commands on an external *nix system through a ServiceNow® MID Server. The step also stores scripts and commands for the *nix systems.

**Note:**
- The SSH step is not available in the base system. The step requires the subscription to ServiceNow® IntegrationHub and activation of IntegrationHub Professional Pack Installer (com.glide.hub.integrations.professional) or later. For more information about the IntegrationHub subscription packages, see IntegrationHub usage and subscription. After you activate the required plugin, the step is visible under Integrations.
- IntegrationHub supports ServiceNow SSH only.

### Roles and availability

The SSH step is available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.
Sanitizing arguments using the escape class and function

Escape all user inputs to eliminate the possibility of a malicious user executing arbitrary commands on your target server. Escape and validate data pills before the command field uses them by sanitizing arguments using a preprocessing Script step. Precede the SSH step with a Script step, which takes the arguments that are used to construct a command in the SSH step.

In the Script step, use the escape class, GlideShellEscapeUtils and escape function, escapeBashShellArg. The escaped arguments are the output of the Script step. Use this escaped output as the arguments of the commands used in the SSH step. The escaped values should contain arguments of a command.

**Escape APIs**

<table>
<thead>
<tr>
<th>Escape class/function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlideShellEscapeUtils</td>
<td>Provides scripted APIs to escape the shell arguments. For example, var escapedArgument = SNC.GlideShellEscapeUtils.escapeBashShellArg(&quot;/etc &amp;&amp; cat myfile.txt&quot;); The escaped argument is, '/etc &amp;&amp; cat myfile.txt'.</td>
</tr>
<tr>
<td>escapeBashShellArg</td>
<td>• Adds single quotes around a string. • Escapes any existing single quotes within a string enabling you to pass the string directly to a shell function and treat the string as a single safe argument.</td>
</tr>
</tbody>
</table>

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Details</td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td>Type of connection to use.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Define Connection Inline</strong>: Define connection information within the action step.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Connection Alias</strong>: Define connection information using the Connection Alias table. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action.</td>
</tr>
<tr>
<td></td>
<td>To learn more about connections and credentials, see credentials, connections, and aliases.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection &amp; Credential alias record the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using an action in multiple environments. Likewise, if the connection information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane. This field is available when Use Connection Alias is selected from the Connection list.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias the system uses to run the action step. Users with the flow_designer or admin role can create or select an associated Connection record. Using an alias eliminates the need to configure multiple credentials when using an action in multiple environments. Likewise, if the credential information changes, you don't need to update your custom action. To learn more about connections and credentials, see credentials, connections, and aliases. The credential value is displayed as a Password (2 Way Encrypted) data pill on the data pane. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Host</td>
<td>Host name or IP address of the target server. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Option to use a MID Server to run the SSH step. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Capability of the MID Server. Select SSH. This field is available when Define Connection Inline is selected from the Connection list.</td>
</tr>
<tr>
<td>SSH Configuration</td>
<td></td>
</tr>
<tr>
<td>Working Directory</td>
<td>Optional target directory on the target host where the command is run.</td>
</tr>
<tr>
<td>Command</td>
<td>Command that runs on the target directory. The command can also include MID Serverscripts. See Advanced SSH script options for more information.</td>
</tr>
</tbody>
</table>

**Note:** Escape and validate data pills before the command field uses them by sanitizing arguments using a preprocessing Script step. For more information, see Sanitizing arguments using the escape class and function.
Field | Description
--- | ---
Long Running | Option to disable the SSH connection timeout for commands that might take longer than the default time of 120 seconds to run. When selected, the engine detaches from the execution thread until completion.
Sudo Mode | Option to elevate privileges to execute the script.

For more information, see [SSH credentials](#).

**Advanced SSH script options**

To run a MID Server script on the target host, specify the script type and pass the name of the script into the `${syncFile()}` parameter. The system uses this parameter to locate the named script in the MID Server Script File [ecc_agent_script_file] table and run it on the target host. For example, a bash script can be expressed as:

```bash
bash ${syncFile("<MID script name>")} argument1 argument2 argument3
```

A base script (main_script.bash) can reference another script (my_include.bash) as well as a separate file (.my_profile) located on the target host. Both scripts and the file referenced must be synced to the MID Server, using the `${syncFile()}` parameter, to execute properly.

```bash
source ${syncFile(".my_profile")}
cp ${syncFile("my_include.bash")} /usr/ssmith/my_include.bash
bash ${syncFile("main_script.bash")} one two three four five six
rm /usr/ssmith/my_include.bash
```

A Python example with inline comments might look like this:

```python
set $LIB_DIR=/usr/bin;
# Sync a file that is referenced inside myF5CreateLBPool.py
cp ${syncFile("specialFunctions.py")} ~/specialFunctions.py
# set up environment variables
source ${syncFile(".python_profile")}
# call script that sets up dependencies on the box from remote package repos
python ${syncFile("setupPythonDependencies.py")} pycontrol
# call a script that requires functions from the package as well as a function from myIncludedFile
python ${syncFile("myF5CreateLBPool.py")} snow_pool myActualValue
# user is responsible for their own cleanup
rm ~/specialFunctions.py
```

To see the list of available MID Server scripts, navigate to MID Server > Script Files.

**XML parser step**

Identify structured data from an XML payload without having to write script. Map incoming XML elements to a complex object output that you can use in other steps or actions. At runtime, values from an XML payload populate the complex object output.

To learn more about complex objects, see Complex data.
Roles and availability

- Available as an Action Designer action step. Users with the action_designer role can create a custom action with one or more action steps.

Payload size limit

At runtime, XML parser step supports payloads up to 10 MB. For larger payloads, create a Data Stream action. For more information, see Data Stream actions and pagination.

At design time, XML parser step supports sample payloads up to 64,000 characters.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source data</td>
<td>Select or drag a data pill that contains the source XML data. For example, a REST step Response Body data pill. At runtime, values from the data source populate the complex object output.</td>
</tr>
</tbody>
</table>
| Payload view        | Select a view for the example payload.  
  - **Raw (edit mode):** Displays editable XML.  
  - **Structured:** Displays XML in a tree view. Click an element in the tree to copy the element XPath. If creating complex data in the Target field manually, you can paste the XPath into the target XPath field. |
| Example payload     | Enter an example payload to generate a complex object. For example, if parsing the response from a REST API step that returns a list of users, enter the expected XML for a single user. This field accepts XML with the following limitations.  
  - XML namespaces are not applied to the complex object. More than one namespace in an XML file is not supported and generates an error message.  
  - Multidimensional arrays are not supported.  
  - Some special characters are not supported, such as hyphen and period. Double colons (::) are not supported in attribute values.  
  - Payloads larger than 64,000 characters cannot be saved and generate an error message. However, if working with a large example, you can generate the complex object and delete the example payload before saving the step. |
| Generate Target     | Click to generate a complex object from the example payload. Review and edit the Target field as necessary. Child elements are generated as type String. Alternatively, manually create the target by adding items in the Target field. |
### Field Description

**Target**

View the XML payload as a complex object. Generate structured data by clicking *Generate Target*, or manually add items. For more information, see Complex data.

Each complex data variable contains this information.

- **Label**: Data pill label. By default, the system uses the name of the XML element.
- **Preview**: Sample value from the example payload.
- **Type**: Data type, which must be String, Object, Array.String, or Array.Object. The top-level item must be an Object.
- **XPath**: Path to the element. Modify the XPath to change how source data elements map to complex data variables. If manually adding complex data variables, you can copy the XPath from the Payload view field and paste it in a complex data variable XPath field to ensure the correct hierarchy. Conditional XPath expressions are not supported.

Click **Edit Object** to:

- Change the label, internal name, or data type
- Add or remove complex data variables
- Mark a variable mandatory

---

**Password reset using IntegrationHub**

Create subflows in IntegrationHub to automate and customize the password reset process for users managed by third-party applications such as Okta or Microsoft Azure AD.

Create subflows in IntegrationHub to automate password reset processes. Use the Password Reset application to enable an end user to use a self-service process to reset or change the password. Alternatively, your organization can implement a process that requires a service desk agent to reset passwords for end users. See Customize password reset processes and integrate third-party credential services for more information.

---

**Interaction Management**

Interactions are a centralized location for all communication channels in the platform. Each interaction represents a request for assistance through a given channel, for example, a call or a chat.

The Now Platform offers several forms of queueing and communication management, but each system is tightly coupled to the specific area. Interactions offer an alternative, flexible, and more extensible option so that each product area can use the same framework.

**Activate the interaction management system**

An administrator can activate the Interaction Logging, Routing, and Queueing plugin [com.glide.interaction] to access the functionality.

Role required: admin

For plugin activation steps, see Activate a plugin.

1. Navigate to **System Applications** > **All Available Applications** > **All**.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Components installed with Interaction Management

Several types of components are installed with activation of the Interaction Logging, Routing, and Queueing plugin, including tables and user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

#### Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interaction Administrator</td>
<td>Configure interactions for users.</td>
<td>• interaction_agent</td>
</tr>
<tr>
<td>[interaction_admin]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interaction Agent</td>
<td>Create and edit interactions. Transfer interactions to different agents or queues.</td>
<td>None</td>
</tr>
<tr>
<td>[interaction_agent]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interaction</td>
<td>Table for all interaction records.</td>
</tr>
<tr>
<td>[interaction]</td>
<td></td>
</tr>
<tr>
<td>Interaction JSON blob</td>
<td>List of records that store context information for each interaction.</td>
</tr>
<tr>
<td>[interaction_json_blob]</td>
<td></td>
</tr>
<tr>
<td>Interaction related record</td>
<td>List of related records that have been associated with an interaction.</td>
</tr>
<tr>
<td>[interaction_related_record]</td>
<td></td>
</tr>
</tbody>
</table>

### Interaction configuration overview

Configure the behavior of an interaction by determining the routine behavior for each state that the interaction goes through during the life cycle.
Interaction framework

Configure each of the following interaction components to determine the behavior and life cycle.

- Lists: Configure the interaction list view. You can also extend the interaction table.
- Forms: Configure the form view to tailor interactions for each application.

Interaction states

States determine the behavior for interactions. For each state of the interaction life cycle, you determine which routine actions to perform. For example, the On Created state would have a script that creates an interaction and then adds the end user as the 'opened for'. The script then sends a message to the end user to let them know that the interaction has been opened.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>An interaction is inserted into the interaction table</td>
</tr>
<tr>
<td>On Hold</td>
<td>The interaction is waiting for assignment</td>
</tr>
<tr>
<td>Work In Progress</td>
<td>An agent accepts an unassigned interaction</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>The agent or consumer intentionally closes the interaction</td>
</tr>
<tr>
<td>Closed Abandoned</td>
<td>The interaction is closed because the consumer disconnects or is unresponsive</td>
</tr>
</tbody>
</table>

Interaction context and channel metadata

Context and channel metadata are document ID fields included as part of interactions. Both types of records store information about the interaction.

Context

Context for an interaction tracks the information for an interaction, such as the initial question, asset tagging, or device location. Context records are stored on the interaction_json_blob table by default, however you can use any table to store a context record.

Channel metadata

Channel metadata contains the information needed to interact with the channel on which communication is happening on, for example, the chat or phone channels. Channel metadata can be free-form JSON or a reference to another record.

Create an interaction

Most interaction creation takes place in other applications, interactions are merely a method of controlling channels. However, if needed you can create an interaction from the Interaction application.
Role required: interaction_agent

1. Navigate to Interaction > All.
2. Click New.
3. In the Type field, enter the way the interaction began. For example, chat, phone, or walk-up.
4. In the Opened for field, type the name of the user starting the interaction.
5. Include any additional information in the short description and the work notes fields.

View any incidents opened by the same user by clicking the Use the Incidents by Same Caller related list.

**Associate a record with an interaction**

As an agent, you might need to create a record on another table to work on an interaction. You can associate the record with the interaction.

Role required: interaction_agent

1. Navigate to Interaction > Assigned to me.
2. Open the interaction you want to associate with another record.
3. In the form header, click Associate Record.
4. In the ID of related record field, click the search icon.
5. From the Document Table list, select the table you want to associate a record from.
6. From the Document field, click the search icon.
7. Select an existing record from the list, or click New to create a record.
8. Click OK.
9. Click Submit.

The associated record appears in the Related Tasks related list for the interaction.

**Knowledge Management**

The ServiceNow® Knowledge Management (KM) application enables the sharing of information in knowledge bases. These knowledge bases contain articles that provide users with information such as self-help, troubleshooting, and task resolution.

Knowledge Management has significantly changed with Knowledge v3, which is enabled by default for all instances starting with the Fuji release.

The Knowledge Management Service Portal enables users to access a portal view of knowledge bases and articles. It is available by default for new customers on the Madrid and later releases. If required, existing and upgrade customers can activate the Knowledge Management Service Portal plugin.

Knowledge Management supports processes for creating, categorizing, reviewing, and approving articles. Users can search and browse articles as well as provide feedback.

To support multiple groups, knowledge bases can be assigned to individual managers. Separate workflows can be used for publishing and retiring articles, and separate access controls can be used to control reading and contributing.

**Explore**
- Upgrade to New York
- Knowledge Management v3
- Knowledge Management V3 homepage
- Search using Knowledge Management v3

**Set up**
- Video: Getting Started with Knowledge Management v3
- Knowledge Management setup guide for admins

**Administer**
- Select user criteria for a knowledge base
- Video: How to Control Knowledge Access Through User Criteria
- Blog: Article Security and Filtering in Knowledge v3
- Social Q&A
- Domain separation

- Knowledge base setup guide for knowledge admins and managers
- Define a knowledge article category
- Add a knowledge article to featured content
- Configure Knowledge Management

**Use**

- Knowledge Management roles
- Knowledge Management guide for users
- Use knowledge on mobile devices
- Article versioning
- Article subscriptions
- Knowledge Management Service Portal
- Now Mobile for Knowledge Management

**Migrate**

- Migrate to Knowledge Management v3
- Video: Migrating from Knowledge Management v2 to v3
- Video: Managing Article-Level Access Controls During Migration from KM v2 to v3
- Blog: All things Upgrade considered on Knowledge v2 to v3

**Troubleshoot and get help**

- Knowledge Management FAQs
- Ask or answer questions in the Knowledge Management forum
- Search the HI knowledge base for known error articles
- Duplicate knowledge article numbers
- Contact ServiceNow Technical Support

**Additional plugins for Knowledge Management**

After Knowledge Management is activated, you can activate additional plugins that provide access to various additional Knowledge Management features.

You must have the admin role to activate these additional plugins. For details, see Activate a plugin.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Management Core</td>
<td>Installs the core Knowledge Management items used to allow other Knowledge-related plugins to work, such as Knowledge V3, Knowledge Advanced, and Knowledge Service Portal. This plugin is activated by default.</td>
</tr>
<tr>
<td>com.glideapp.knowledge</td>
<td></td>
</tr>
<tr>
<td>Knowledge Management Advanced Installer</td>
<td>Installs the Knowledge Management Advanced plugin. Activating/upgrading to this plugin validates the knowledge articles and knowledge bases to make sure that the Knowledge Advanced plugin can be successfully installed. If validation fails, check the Plugin Activation logs and follow instructions given to fix any errors. Once you fix all the issues, re-run this plugin.</td>
</tr>
<tr>
<td>com.snc.knowledge_advanced.installer</td>
<td></td>
</tr>
<tr>
<td>Knowledge Management Advanced</td>
<td>Adds advanced features to Knowledge Management such as version control and subscriptions. This plugin requires that all knowledge bases are version Knowledge V3. Use the Knowledge Management Advanced Installer plugin to activate this plugin.</td>
</tr>
<tr>
<td>com.snc.knowledge_advanced</td>
<td></td>
</tr>
<tr>
<td>Predictive Intelligence for Knowledge Management</td>
<td>Enables you to leverage machine-learning algorithms for searching related articles in Knowledge Management. Activation of this plugin on production instances might require a separate license. Contact ServiceNow for details.</td>
</tr>
<tr>
<td>[com.snc.knowledge_ml]</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Before activating this plugin, you must activate the Predictive Intelligence plugin (com.glide.platform_ml).
<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Analytics - Content Pack - Knowledge Management</td>
<td>Enables the Performance Analytics content pack for Knowledge Management out-of-the-box KPIs. Activation of this plugin on production instances might require a separate Performance Analytics license. Contact ServiceNow for details.</td>
</tr>
<tr>
<td>com.snc.pa.knowledge_v2</td>
<td></td>
</tr>
<tr>
<td>Knowledge Management V3</td>
<td>Enables support for Knowledge Management V3. Activate this plugin when you upgrade from Eureka or earlier versions.</td>
</tr>
<tr>
<td>com.snc.knowledge3</td>
<td></td>
</tr>
<tr>
<td>I18N: Knowledge Management Internationalization Plugin v2</td>
<td>Helps create and maintain translations of an article in various languages in a way that is easy to manage translations while authoring as well as viewing articles. Activating internationalization plugins for any of the available languages automatically activates this plugin.</td>
</tr>
<tr>
<td>com.glideapp.knowledge.i18n2</td>
<td></td>
</tr>
<tr>
<td>Knowledge Document</td>
<td>Adds knowledge-based functionalities to the Managed Documents plugin. You can create a knowledge article from a document or update a knowledge document to a newer revision.</td>
</tr>
<tr>
<td>com.snc.knowledge_document</td>
<td></td>
</tr>
<tr>
<td>Knowledge Management - External Content Integration</td>
<td>Adds external content search capabilities to the Knowledge Management application. Once configured, this feature creates a copy of the external content on ServiceNow as knowledge articles, and then indexes the articles through Zing Search. You must have appropriate reuse and copy privileges before you configure an external source to be searchable using this feature.</td>
</tr>
<tr>
<td>com.snc.knowledge.external_integration</td>
<td></td>
</tr>
<tr>
<td>Knowledge Management Wiki Support</td>
<td>Enables support for wiki type Knowledge articles.</td>
</tr>
<tr>
<td>com.glideapp.knowledge2.wiki</td>
<td></td>
</tr>
</tbody>
</table>

**Knowledge Management roles**

Certain roles are required to use Knowledge Management functionality.

**Knowledge Management roles**

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>knowledge</td>
<td>Users with the knowledge role can contribute to the default knowledge base and access the Knowledge application menu. The knowledge role is fullfiller role and not a requester role.</td>
</tr>
<tr>
<td>knowledge_manager</td>
<td>Knowledge managers perform administrative functions for knowledge bases they manage such as defining categories, pinning important articles, and approving changes to articles. Users selected as managers of a knowledge base receive this role automatically.</td>
</tr>
<tr>
<td>knowledge_admin</td>
<td>Knowledge administrators can create new knowledge bases and manage all knowledge bases.</td>
</tr>
<tr>
<td>knowledge_coach</td>
<td>Knowledge coaches can perform AQI surveys on articles, write, edit and review knowledge articles, and coach the team on best practices.</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>knowledge_domain_expert</td>
<td>Knowledge domain experts perform AQI surveys on articles and can write, edit and review knowledge management articles. A knowledge domain expert keeps track on the health of knowledge base.</td>
</tr>
<tr>
<td>admin</td>
<td>Administrators can configure knowledge workflows, set knowledge properties, and manage knowledge forms and homepages.</td>
</tr>
<tr>
<td>knowledge_group_manager</td>
<td>Knowledge group managers can add or remove members in ownership groups managed by them. They cannot change the manager assigned in their groups. The manager can only be reassigned by the knowledge administrator. Knowledge group managers are assigned feedback tasks by default. They can reassign tasks to another group member, or group members can assign a feedback task to themselves.</td>
</tr>
<tr>
<td>knowledge_group_member</td>
<td>Knowledge group members are part of an ownership group that can be associated to knowledge articles. They can approve knowledge articles, assign feedback tasks to themselves and work on them as well as edit any knowledge articles that their ownership group is assigned to.</td>
</tr>
</tbody>
</table>

**Knowledge properties**

As an administrator, you can configure the look and functionality of many knowledge base features with knowledge properties.

You can access knowledge properties by navigating to Knowledge > Administration > Properties.

**Knowledge portal properties**

Knowledge portal properties control the look and functionality of the legacy portal page. This portal page lists recent knowledge articles and their publishing dates, organized by topic.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of columns on Knowledge portal pages.</td>
<td>Set the number of columns for arranging topics on the knowledge portal.</td>
</tr>
<tr>
<td>(glide.knowman.columns)</td>
<td><strong>Note:</strong> This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum number of articles per content block on the home page (glide.knowman.content_block_limit) | Enter the maximum number of articles to display in the **Most Useful** and **Most Viewed** sections of the knowledge homepage.  
**Note:** This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages. |
| Omit empty Knowledge topics and categories. (glide.knowman.show_only_populated) | Select the **Yes** check box to display topic sections only if there are articles for the topic. Clear the check box to show all topic sections, even those with no assigned articles.  
**Note:** This property does not apply to the News category.  
**Note:** This property applies only to the default knowledge base and the legacy knowledge portal. Knowledge Management v3 articles do not specify a topic. Therefore, this property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages. |
| Show Knowledge section descriptions. (glide.knowman.show_descriptions) | Select the **Yes** check box to display topic descriptions in the knowledge portal. To enter these descriptions:  
1. Edit an existing knowledge article.  
2. Right-click the **Topic** field label and choose **Show Choice List**.  
3. Open the record for the topic name and enter the description into the **Hint** field.  
Clear the check box to omit section descriptions from the knowledge portal.  
**Note:** This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages. |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Knowledge Base items to preview in a section. (glide.knowman.section_limit)</td>
<td>Set the maximum number of articles per topic for the knowledge portal. The specific articles shown depends on the Knowledge section sort field property setting.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages.</td>
</tr>
<tr>
<td>Knowledge section sort field. (glide.knowman.section_sort)</td>
<td>Select the default order for articles within each topic section on the knowledge portal.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Published:</strong> uses the date published.</td>
</tr>
<tr>
<td></td>
<td>• <strong>View count:</strong> uses the number of times articles have been viewed during the period specified in the Number of days used when summing article views property (applicable only in Knowledge Management v2.)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Alphabetically:</strong> uses the first letter of the article title (Short description field).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages.</td>
</tr>
<tr>
<td>Knowledge Base section sort direction. (glide.knowman.section_sort_direction)</td>
<td>Select the order, ascending or descending, in which articles are listed within each topic section on the knowledge portal. The value used for sorting is set in the Knowledge section sort field property.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages.</td>
</tr>
<tr>
<td>Show unpublished articles in Knowledge Base portal and topic lists. (glide.knowman.show_unpublished)</td>
<td>Select the Yes check box to allow users to see unpublished articles in the knowledge portal and knowledge search results. Use the subsequent List of roles... properties to designated which users can see articles in various unpublished states. If this is not selected, users with appropriate roles can access unpublished articles through other modules of the Knowledge Base application.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>List of roles (comma separated) that can see articles in the Review workflow state in the Knowledge portal and Topic list. (glide.knowman.section.view_roles.review)</td>
<td>Enter role names exactly as they appear in User Administration &gt; Roles. If Show unpublished articles in Knowledge Base portal and topic lists is selected, users with these roles see articles in the Review workflow state in the knowledge portal, in the topic list that appears when they click a topic title on the portal, and in knowledge search results.</td>
</tr>
<tr>
<td>List of roles (comma separated) that can see articles in the Draft workflow state in the Knowledge portal and Topic list. (glide.knowman.section.view_roles.draft)</td>
<td>Enter role names exactly as they appear in User Administration &gt; Roles. If Show unpublished articles in Knowledge Base portal and topic lists is selected, users with these roles see articles in the Draft workflow state in the knowledge portal, in the topic list that appears when they click a topic title on the portal, and in knowledge search results.</td>
</tr>
<tr>
<td>Define roles that can view articles in other/custom workflow states. Do not include Draft and Review states, as they are already defined in other properties. (glide.knowman.section.view_roles.stagesAndRoles)</td>
<td>Enter role names exactly as they appear in User Administration &gt; Roles. If Show unpublished articles in Knowledge Base portal and topic lists is selected, define the custom field and role as workflow state:[roles];. The users with these roles see articles in the custom workflow state on the knowledge portal. The property is not applicable to the retired knowledge articles. Only users with the knowledge_admin role can view retired articles.</td>
</tr>
</tbody>
</table>
| The number of articles that are asynchronously loaded when scrolling down in the new search results page. (glide.knowman.search.articles_per_page) | Enter the number of articles to be displayed during a search.  
**Note:** This property applies only to Knowledge Management v3 pages. This property is not supported on Knowledge Management v2 pages. |
| Show only Knowledge topic titles on portal page (no article links). (glide.knowman.home_titlesonly) | Select the Yes check box to omit all article titles from the knowledge portal and show only the topic names. Users can click the topic title to see the list of related articles.  
**Note:** This property applies only to Knowledge Management v2 pages. This property is not supported on Knowledge Management v3 pages. |
## Knowledge search properties

Knowledge search properties give you control over the search options available to users and the presentation of search results.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Knowledge search result order. (glide.knowman.order.search) | Select the order for displaying search results:  
  - **Number of Views**: orders search results based on the **Number of days used when summing article views** property.  
  - **Relevancy**: orders search results based on content that is similar to the search term.  
  - **Last Modified**: orders search results based on modification date.  
  This property is applicable for search within the Knowledge Management application and not the Now Platform global search. |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search method used when searching Knowledge from a task or directly in the Knowledge Base. (glide.knowman.search.operator)</td>
<td>Select the search approach to use when the search term includes multiple words.</td>
</tr>
<tr>
<td></td>
<td>• <strong>OR query</strong>: returns articles that contain at least one word from the search term.</td>
</tr>
<tr>
<td></td>
<td>• <strong>AND then OR query</strong>: first searches for articles that include all words in the search term (an AND query). If no matches are found, an OR query is performed.</td>
</tr>
<tr>
<td>Show author in knowledge search results. (glide.knowman.search.show_author)</td>
<td>Select this check box to include the author of each article in knowledge search results.</td>
</tr>
<tr>
<td></td>
<td>If the article versioning feature is enabled, articles with a version number less than or equal to 1.0 display <strong>Authored by &lt;name&gt;</strong> and articles with a version number greater than 1.0 display <strong>Revised by &lt;name&gt;</strong>.</td>
</tr>
<tr>
<td>Show last modified date and time in knowledge search results. (glide.knowman.search.show_last_modified)</td>
<td>Select this check box to include the date and time each article was last edited in knowledge search results.</td>
</tr>
<tr>
<td>Show publish date in knowledge search results. (glide.knowman.search.show_published)</td>
<td>Select this check box to include the date each article was published in knowledge search results.</td>
</tr>
<tr>
<td>Show category in knowledge search results. (glide.knowman.search.show_category)</td>
<td>Select this check box to include the category breadcrumbs of each article in knowledge search results.</td>
</tr>
<tr>
<td>Show number of views in knowledge search results. (glide.knowman.search.show_view_count)</td>
<td>Select this check box to include the number of times each article was viewed in knowledge search results.</td>
</tr>
<tr>
<td>How to display attachments in Knowledge Search Results. (glide.knowman.search.attachment)</td>
<td>Select the behavior of how the attachments are shown in the search results:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Do not show attachment</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Show only link for attachment</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Show attachment with text snippet</strong> (default)</td>
</tr>
<tr>
<td></td>
<td>For best performance, select <strong>Do not show attachment</strong>, or <strong>Show only link for attachment</strong>.</td>
</tr>
<tr>
<td>Show relevancy in knowledge search results. (glide.knowman.search.show_relevancy)</td>
<td>Select this check box to show how relevant each search result is based on the search string. <strong>Relevancy</strong> value is only shown when knowledge search result order property is set to <strong>Relevancy</strong>.</td>
</tr>
<tr>
<td>Enable instant search results for knowledge. (glide.knowman.search.instant_results)</td>
<td>Select this check box to enable instant search for search results. The default is <strong>No</strong>.</td>
</tr>
<tr>
<td>Show Knowledge Base name in Knowledge search results. (glide.knowman.search.show_knowledgebase)</td>
<td>Select this check box to display the knowledge base to which the knowledge base article belongs. For example, <strong>IT</strong>.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Show average rating from knowledge search results.</strong> <em>(glide.knowman.search.show_rating)</em></td>
<td>Select this check box to display the average star ratings for knowledge base articles. This property is applicable to the search results for knowledge articles that appear on the Knowledge Management Service Portal search results page and service portal widgets such as Knowledge Featured Articles and Knowledge Most Viewed Articles. For more information, see Knowledge Management Service Portal search results page features and Configure the home page widget instance options.</td>
</tr>
<tr>
<td><strong>Show article number in knowledge search results.</strong> <em>(glide.knowman.search.show_article_number)</em></td>
<td>Select this check box to display the article number for each article in the search result. If the article versioning feature is enabled, the article number and the version number are displayed for each article in the search result.</td>
</tr>
<tr>
<td><strong>Specify default language for searching articles.</strong> <em>(glide.knowman.search.default_language)</em></td>
<td>Set the property to the desired default language for searching articles.</td>
</tr>
</tbody>
</table>
| - **String**  
- **Default value:** user-specified  
- **Location:** System Properties |  
| **Enable multi-language search.** *(glide.knowman.enable_multi_language_search)* | Set the property to True to enable search for multiple languages simultaneously.  
| - **Type:** true | false  
- **Default value:** false  
- **Location:** System Properties |  
<p>| <strong>Note:</strong> If this property is set to True, it overrides the setting for the glide.knowman.search.default_language property. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum character limit for meta description used for SEO.</td>
<td>Set the maximum number of characters used as meta description for SEO.</td>
</tr>
<tr>
<td>(glide.knowman.seo.pages.meta_description)</td>
<td>Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 100</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties</td>
</tr>
<tr>
<td></td>
<td>When you change the character limit, the meta description with the updated limit is only applied to articles published after the change was made. To apply the change to all existing published articles, run the Populate Meta Description on KB Articles fix script.</td>
</tr>
</tbody>
</table>

**Knowledge article view properties**

Article view properties give you control over the meta data and rating options that appear with articles. They also enable you to grant access to individual feedback options based on user role.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show tasks to which an article has been recently attached.</td>
<td>Select the Yes check box to have article view include a list of tasks associated with the article. The list of associated tasks appears on the Most Recent Tasks widget on the article view page. The widget appears only when a task is attached to the article and this property is set to Yes. Knowledge articles can be attached to a task by clicking the Attach to Task button after searching from a form.</td>
</tr>
<tr>
<td>(glide.knowman.recent_tasks.display)</td>
<td></td>
</tr>
<tr>
<td>Number of attached tasks to display when viewing an article.</td>
<td>Specify the maximum number of tasks to list in article view.</td>
</tr>
<tr>
<td>(glide.knowman.recent_tasks)</td>
<td></td>
</tr>
<tr>
<td>Show article rating section, which may optionally include yes/no rating, star rating, and flagging options.</td>
<td>Select the Yes check box to display the rating options for users with specific roles. Clear this check box to omit the rating section for all users, regardless of role. The Feedback field is always displayed for all users.</td>
</tr>
<tr>
<td>(glide.knowman.show_rating_options)</td>
<td></td>
</tr>
<tr>
<td>List of roles (comma separated) that can see an article's rating section, which may optionally include yes/no rating, star rating, and flagging option.</td>
<td>Enter role names exactly as they appear in User Administration &gt; Roles. If Show article rating section... is selected, users with the roles listed here see the yes/no rating, star rating, and flagging options, according to related property settings. Be sure to include all roles that should be permitted to see any of these rating options. Separate properties enable you to identify specific roles for each option separately. All roles in those properties must also be listed here.</td>
</tr>
<tr>
<td>(glide.knowman.show_rating_options.roles)</td>
<td></td>
</tr>
<tr>
<td>Show the &quot;Was this article helpful?&quot; yes/no rating option.</td>
<td>Select the Yes check box to display the &quot;Was this article helpful?&quot; rating to users with roles set in the associated property. This appears only if the Show article rating section... property is selected.</td>
</tr>
<tr>
<td>(glide.knowman.show_yn_rating)</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>List of roles (comma separated) that can see yes/no &quot;Was this article helpful?&quot; rating option. (glide.knowman.show_yn_rating.roles)</td>
<td>Enter role names exactly as they appear in User Administration &gt; Roles. If both Show article rating section... and Show the &quot;Was this article helpful?&quot; properties are selected, users with the roles listed here see the &quot;Was this article helpful?&quot; rating in article view. All roles listed here must also be listed in the List of roles that can see an article’s rating section...&quot; property.</td>
</tr>
<tr>
<td>Show &quot;Create Incident&quot; link. (glide.knowman.create_incident_link.display)</td>
<td>Select the Yes check box to display the Create Incident link.</td>
</tr>
<tr>
<td>URL used for the &quot;Create Incident&quot; link. (glide.knowman.create_incident_link)</td>
<td>Enter the URL for the page where users can create an incident only if the Show &quot;Create Incident&quot; Link...&quot; property is selected. To find the URL, open the appropriate page, then right-click the header bar and choose Copy URL. Highlight the URL that appears and use the browser’s copy and paste feature to place it into this property field.</td>
</tr>
<tr>
<td>Show five-star rating option. (glide.knowman.show_star_rating)</td>
<td>Select the Yes check box to display the five-star rating to users with roles set in the associated property. This appears only if the Show article rating section property is selected. This property is applicable to the knowledge article view page in the Knowledge Management Service Portal. For more information, see Knowledge Management Service Portal article view page features.</td>
</tr>
<tr>
<td>List of roles (comma separated) that can see five-star rating option. (glide.knowman.show_star_rating.roles)</td>
<td>Enter role names exactly as they appear in User Administration &gt; Roles. If both Show article rating section... and Show five-star rating option properties are selected, users with the roles listed here see the five-star rating option in article view. All roles listed here must also be listed in the List of roles that can see an article’s rating section...&quot; property.</td>
</tr>
<tr>
<td>Show &quot;Flag Article&quot; option to identify incomplete/inaccurate articles. (glide.knowman.show_flag)</td>
<td>Select the Yes check box to display the flag article option to users with roles set in the associated property. This appears only if the Show article rating section... property is selected.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>List of roles (comma separated) that can flag incomplete/inaccurate articles. <em>(glide.knowman.show_flag.roles)</em></td>
<td>Enter role names exactly as they appear in <strong>User Administration &gt; Roles</strong>. If both <strong>Show article rating section...</strong> and <strong>Show &quot;Flag Article&quot; option</strong> properties are selected, users with the roles listed here see the flag article option in article view. All roles listed here must also be listed in the <strong>List of roles that can see an article's rating section...</strong> property.</td>
</tr>
<tr>
<td>Show user comments on knowledge articles. <em>(glide.knowman.show_user_feedback)</em></td>
<td>Select an option for showing user comments <strong>When article loads</strong>, <strong>When user clicks link to show comments</strong>, or <strong>Never</strong> for users with roles set in the associated property:</td>
</tr>
<tr>
<td>List of roles (comma separated) that can see user comments on an article. <em>(glide.knowman.show_user_feedback.roles)</em></td>
<td>Enter role names exactly as they appear in <strong>User Administration &gt; Roles</strong>. If the <strong>Show user comments on knowledge articles</strong> property is selected, users with the roles listed here see user comments in article view.</td>
</tr>
<tr>
<td>Maximum number of user comments displayed on a knowledge article. <em>(glide.knowman.feedback.display_threshold)</em></td>
<td>Set the maximum number of user comments to display. If no value is set, all comments are displayed. This property does not apply to live feed comments on the article view page.</td>
</tr>
<tr>
<td>Use Live Feed for Knowledge feedback. <em>(glide.knowman.use_live_feed)</em></td>
<td>Set the property to <strong>True</strong> to use live feed to manage and display feedback on knowledge articles.</td>
</tr>
</tbody>
</table>
| | **Type:** true|false  
| | **Default value:** false  
| | **Location:** System Properties |

**Knowledge homepage properties**

Knowledge homepage properties control the featured content on the knowledge homepage.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display or hide the count of articles and questions in the Knowledge Homepage. <em>(glide.knowman.show_number_on_homepage)</em></td>
<td>Select to display or hide the count of knowledge articles and questions on the Knowledge homepage.</td>
</tr>
<tr>
<td>Default keyword for getting pinned articles <em>(glide.knowman.default_keyword)</em></td>
<td>Enter a default keyword for pinned articles. Articles pinned with the specified keyword appear in the Featured Content section of the knowledge homepage.</td>
</tr>
<tr>
<td>Display or hide the count of articles and questions in the category and child categories <em>(glide.knowman.show_number_on_category)</em></td>
<td>Select to display the count of articles and questions within each category, including subcategories, when browsing or searching knowledge bases.</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Knowledge Home page when user has access to only one Knowledge Base</td>
<td>Select to display the Knowledge homepage when the current user has access to only one knowledge base.</td>
</tr>
<tr>
<td>(glide.knowman.show_home_if_one_kb)</td>
<td></td>
</tr>
<tr>
<td>Default header title for the pinned articles section on knowledge home pages</td>
<td>Enter a title for the Featured Content section of the knowledge homepage.</td>
</tr>
<tr>
<td>(glide.knowman.default_pinned_section_header_title)</td>
<td></td>
</tr>
</tbody>
</table>

**Other knowledge properties**

Other knowledge properties let you control general knowledge management features.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When attaching an article to an incident, copy the content into this field. (glide.knowman.attach.fields)</td>
<td>When a user searches knowledge from a task form (such as an incident, problem, or change) and clicks the <a href="#">Attach to Task</a> button for an article, the system copies the article number and content into the field specified in the Value column here. This field is generally a journal field such as <strong>Comments</strong> or <strong>Work notes</strong>. Use dot walking to copy the article content into related records. If a specified field does not exist, that field is ignored. If the property has no value, comments is used.</td>
</tr>
<tr>
<td>Displays a read-only article view page when articles are viewed from contextual search (glide.knowman.contextual_search.show_read_only_article)</td>
<td>Displays a read-only article view page when knowledge articles are viewed from contextual search.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
</tbody>
</table>

**Note:** The glide.knowman.contextual_search.show_read_only_article property is activated by default. If the property isn’t available, add it manually and set its value to true to display read-only knowledge articles accessed from the contextual search. For more information, see [Add a system property](#).
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Management logo to display if running out of the ServiceNow frames. (glide.knowman.frameless_logo)</td>
<td>Click the reference lookup tool ( Icon Reference Lookup ) and choose an image file to be displayed on knowledge pages that are used outside of the ServiceNow application frames. For example, the logo image selected here appears if you create a Content Management System site that includes knowledge pages. You can also enter the Name of an image stored in the database to use that image.</td>
</tr>
<tr>
<td><strong>Note:</strong> This property applies only to Knowledge v2 pages. This property is not supported on Knowledge v3 pages.</td>
<td></td>
</tr>
<tr>
<td>Hide the 'Import' functionality (button and drag-n-drop) for all users. (glide.knowman.import.hide_import_functionality)</td>
<td>Select Yes to hide the Import Articles button. If you have not yet migrated to Knowledge v3 and are using legacy Knowledge v2, you can configure the visibility of the Import Articles button to prevent users from importing articles to knowledge bases.</td>
</tr>
<tr>
<td>Show publish check box on the knowledge import pop-up. (glide.knowman.import.show_publish_checkbox)</td>
<td>Select No to remove the Publish check box on the knowledge import form so that an article cannot be published as part of the import process. Default is yes.</td>
</tr>
<tr>
<td>Use submission workflow. (glide.knowman.submission.workflow)</td>
<td>Select the Yes check box to use the knowledge submission workflow instead of the standard knowledge workflow. If this option is selected, each time a user creates knowledge from an incident or problem, the content is placed into a submission record instead of a draft article. Transforming knowledge submissions into articles follows a specific workflow.</td>
</tr>
<tr>
<td>Disable creating or updating articles larger than server size limit. (glide.knowman.check_article_size)</td>
<td>Select Yes to disable creating or updating knowledge articles with content more than server limit of the Now Platform. By default, the server limit is 1 MB. Therefore, you can't create or edit knowledge articles with content more than 1 MB. The limit doesn't apply to the attachments of a knowledge article. This property is enabled by default. If you disable the property, you might be able to create articles up to 2 MB. However, you can't perform any UI actions such as submit, check out, update, and publish.</td>
</tr>
<tr>
<td><strong>Note:</strong> This property only applies when creating and updating articles in the Now Platform interface because of the server limitation.</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The sys_id of the knowledge base when creating knowledge from task records. (glide.knowman.task_kb)</td>
<td>Enter the sys_id of the knowledge base to put new knowledge articles created from tasks in.</td>
</tr>
<tr>
<td>Before displaying the text of the article in search results or the article view, check field-level ACLs on appropriate field: kb_knowledge.text (HTML article) or kb_knowledge.wiki (wiki text article). (glide.knowman.text.check_can_read)</td>
<td>Select this check box if users must have ACL-based permission to view text fields on the Knowledge [kb_knowledge] table to read article previews in knowledge search results.</td>
</tr>
<tr>
<td>Defines the number of results to be considered when building the search filters (glide.knowman.search.facet_depth)</td>
<td>Define maximum number of knowledge articles to be considered from search results for populating search filters.</td>
</tr>
<tr>
<td>Send notification to approvers and authors in article approval workflow (glide.knowman.enable_approval_notification)</td>
<td>Select this check box to send approval email notifications. By default, the property is enabled.</td>
</tr>
<tr>
<td>Allow articles in the global domain to be checked out or edited by users in another domain (glide.knowman.allow_edit_global_articles)</td>
<td>Enter the value as true to enable checking out and editing global articles for users from a domain other than the global domain.</td>
</tr>
<tr>
<td>When showing a list of articles through the Knowledge portal (using the kb_list UI Page), remove articles the user cannot see before building the list. (glide.knowman.list.filter)</td>
<td>Enter the value as true to enable removal of articles that user cannot see before building the articles list in the knowledge portal.</td>
</tr>
<tr>
<td>Create translation task when an article is published (glide.knowman.translation.enable_translation_task)</td>
<td>Enter the value as true to enable creation of translation tasks.</td>
</tr>
</tbody>
</table>

**Note:** When you enable this property, you can’t modify the knowledge base of existing articles.
### Property

<table>
<thead>
<tr>
<th>Deny access to a knowledge base when either Can Read or Can Contribute user criteria list for the knowledge base isn't specified (glide.knowman.block_access_with_no_user_criteria)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td><strong>Type:</strong></td>
</tr>
<tr>
<td><strong>Default value:</strong></td>
</tr>
<tr>
<td><strong>Location:</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Determines whether to apply ACLs on the search results (glide.knowman.search.apply_acls)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td><strong>Type:</strong></td>
</tr>
<tr>
<td><strong>Default value:</strong></td>
</tr>
<tr>
<td><strong>Location:</strong></td>
</tr>
</tbody>
</table>

### Knowledge Social Q&A properties

You can set the limit for the number of times users can ask, answer, or subscribe to Social Q&A questions, or comment on the questions and answers using the Social Q&A system properties.

**Note:** To open the System Properties [sys_properties] table, enter `sys_properties.list` in the navigation filter.

**Note:** If the Value field for any of the Social Q&A properties is left blank, then a rate limit does not apply for that particular property.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum number of Social Q&A questions that can be posted per user per day. | Enter the maximum number of times a user can post Social Q&A questions per day.  
\[sn_kb_social_qa.max_questions_per_user_daily\] 
- Type: Integer  
- Default value: 500  
- Location: System Properties |
| Maximum number of Social Q&A answers that can be posted per user per day. | Enter the maximum number of times a user can post answers to the Social Q&A questions per day.  
\[sn_kb_social_qa.max_answers_per_user_daily\] 
- Type: Integer  
- Default value: 500  
- Location: System Properties |
| Maximum number of Social Q&A comments that can be posted per user per day. | Enter the maximum number of times a user can post comments to the Social Q&A questions or answers per day.  
\[sn_kb_social_qa.max_comments_per_user_daily\] 
- Type: Integer  
- Default value: 500  
- Location: System Properties |
| Maximum number of times a user can subscribe to Social Q&A questions per day. | Enter the maximum number of times a user can subscribe to Social Q&A questions per day.  
\[sn_kb_social_qa.max_subscriptions_per_user_daily\] 
- Type: Integer  
- Default value: 500  
- Location: System Properties |

### Article versioning properties

The knowledge administrator can set knowledge properties that enable users to edit specific fields on published articles without creating new versions.

The article versioning feature requires the Knowledge Management Advanced plugin (com.snc.knowledge_advanced). For more information, see Activate the Knowledge Management Advanced plugin.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable article versioning feature.  
\[glide.knowman.versioning.enabled\] | Select the Yes check box to enable the article versioning feature.  
- Type: true | false  
- Default value: true  
- Location: Knowledge > Administration > Properties |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable minor edits to a published article without creating a new version. (glide.knowman.versioning.enable_minor_edits) | Select the Yes check box to enable minor edits to published articles without creating a new version. When you enable this property, you can also add or remove any attachments associated with knowledge articles.  
  - Type: true | false  
  - Default value: false  
  - Location: Knowledge > Administration > Properties  
  
  **Note:** This feature is available for the following users: the knowledge administrator, the knowledge base manager, and the knowledge base owner.  

| A comma-separated list of fields that can be edited on published articles without creating a new version. (glide.knowman.versioning.minor_edit_fields) | Enter the fields in a comma-separated list that can be edited on published articles without creating a new version.  
  - Type: string  
  - Default value: valid_to  
  - Location: Knowledge > Administration > Properties  

---

**Knowledge subscription properties**

The knowledge administrator can set configuration properties that enable users to subscribe to knowledge bases and knowledge articles.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable subscribe feature for KM (glide.knowman.enable_km_subscription) | Select the Yes check box to enable the Knowledge subscription feature.  
  - Type: true | false  
  - Default value: true  
  - Location: Knowledge > Administration > Properties  

| List of roles (comma-separated) who can have subscription feature (glide.knowman.enable_km_subscription.roles) | Enter the roles in a comma-separated list that can use the Knowledge subscription feature.  
  - Type: string  
  - Default value: knowledge  
  - Location: Knowledge > Administration > Properties  

---

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Article quality index properties

The knowledge administrator can set the pass score for AQI reviews using the knowledge properties page.

#### Properties for Article Quality Index

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pass score for AQI reviews. <code>glide.knowman.aqi_pass_score</code></td>
<td>Set the pass score for AQI reviews.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 70</td>
</tr>
<tr>
<td></td>
<td>• Range of values possible: 1-100</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>List of article workflow states to perform AQI reviews. <code>glide.knowman.aqi.article_workflow_states</code></th>
<th>Enter the article workflow states, in a comma-separated list, where users can perform AQI reviews.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Type: string</td>
<td></td>
</tr>
<tr>
<td>• Default value: draft, review, published</td>
<td></td>
</tr>
</tbody>
</table>

### External Content Integration Properties

Administrators can configure the properties to add allowed content types and change the UI label for the external content integration feature.

#### Properties for External Content Integration

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum limit for total size of external content in Knowledge Management (in GB). <code>sn_km_intg.glide.knowman.external.max_content_size</code></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 2</td>
</tr>
<tr>
<td>Note: This is a read-only field.</td>
<td></td>
</tr>
</tbody>
</table>

| Maximum size of an external article including its attachments (in MB) `sn_km_intg.glide.knowman.external.max_article_size` | • Type: integer                                                             |
|                                                                                                             | • Default value: 8                                                         |
| Note: This is a read-only field.                                                                          |                                                                             |
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_km_intg.glide.knowman.external.allow_content_types</td>
<td>An editable, comma-separated list of allowed content types to be processed from the source system.</td>
</tr>
<tr>
<td>sn_km_intg.glide.knowman.external.reject_content_types</td>
<td>List of content types not allowed to be processed from the source system.</td>
</tr>
<tr>
<td>sn_km_intg.glide.knowman.external.ui_label_for_external_content</td>
<td>UI Label for indicating external articles in Search Results and Article View Pages.</td>
</tr>
</tbody>
</table>

**Note:** This property is read-only and takes precedence over allowed content types.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_km_intg.glide.knowman.external.allow_content_types | **Type:** comma separated values  
**Default value:** application/msword, application/vnd.openxmlformats-officedocument.wordprocessingml.document, application/vnd.ms-excel, application/vnd.openxmlformats-officedocument.spreadsheetml.sheet, application/vnd.ms-powerpoint, application/vnd.openxmlformats-officedocument.presentationml.presentation, application/pdf, text/plain, text/html, image/gif, image/jpeg, image/png  
**Other possible values:** application/xml, video/mp4, audio/mpeg |

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_km_intg.glide.knowman.external.reject_content_types | **Type:** comma separated values  
**Default value:** application/octet-stream, application/x-apple-diskimage, application/vnd.microsoft.portable-executable |

### Actionable Knowledge Feedback Properties

The Knowledge administrator can set configuration properties that would create actionable feedback tasks.

#### Properties for Actionable Knowledge Feedback

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.knowman.feedback.enable_actionable_feedback_for_helpful | Create actionable feedback task when an article is marked as not helpful.  
**Select the Yes check box to enable actionable feedback task generation when an article is marked as not helpful.**  
**Type:** true|false  
**Default value:** false  
**Location:** Knowledge > Administration > Properties |
### Property

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create actionable feedback task when an article is rated at or lower than this value. 0 or no value indicates that actionable feedback tasks are not enabled for Rating type feedback.</td>
<td>An actionable feedback task is created when an article is rated at or lower than this value. The article is rated on a scale of 1-5. <em>Type: integer</em>  <em>Default value: none</em>  <em>Location: Knowledge &gt; Administration &gt; Properties</em></td>
</tr>
</tbody>
</table>

### Knowledge Management setup guide for admins

Before users in your organization can start creating knowledge bases and knowledge articles, you must set up Knowledge Management. Work with stakeholders to define requirements for setting up Knowledge Management effectively to meet the needs of users.

#### Requirements

Role required: admin

#### Before you begin

**Meet with the stakeholders**

<table>
<thead>
<tr>
<th>Stakeholder</th>
<th>Responsibilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge manager</td>
<td>Defines and oversees the knowledge management processes for day-to-day operations related to content publishing and usage.</td>
</tr>
<tr>
<td>Knowledge admin</td>
<td>Configures advanced settings for specific Knowledge Management features</td>
</tr>
<tr>
<td>Knowledge coach</td>
<td>Enables users to adhere to content standards.</td>
</tr>
<tr>
<td>Knowledge domain expert</td>
<td>Provides domain knowledge expertise.</td>
</tr>
<tr>
<td>Version author</td>
<td>Contributor to a particular version of an article.</td>
</tr>
<tr>
<td>Content creators and reviewers</td>
<td>Create, review, and update articles in the knowledge bases.</td>
</tr>
<tr>
<td>Community managers</td>
<td>Focus on the creation and curating of social content.</td>
</tr>
<tr>
<td>Line managers</td>
<td>Manage teams that create and use knowledge articles</td>
</tr>
</tbody>
</table>

**With stakeholders, determine the following requirements**

- Who are the consumers of the content in the knowledge bases?
- Who are the writers, editors, and managers for the knowledge base articles?
- What are the required workflows to publish and retire articles?
- What are the unique behaviors required for your knowledge management implementation? For example, should attachments appear in search results?
• Do you want to translate knowledge articles into other languages?

What to do

Assign knowledge roles to users and groups
Determine which Knowledge Management roles are appropriate for each user, and then assign those roles.

Create custom Knowledge workflows
If the default knowledge workflows for publishing and retiring knowledge articles are not appropriate for your knowledge bases, create custom workflows for those knowledge bases.

Configure Knowledge properties
If the default knowledge properties do not fulfill the requirements of users, reconfigure the properties as necessary.

Activate support for other languages besides English
If languages other than English must be supported, activate the Knowledge Management Internationalization plugins.

Coordinate with knowledge managers for knowledge base setup
Let knowledge managers and administrators know that they can start configuring their knowledge bases. For details, refer them to the Knowledge base setup guide for knowledge admins and managers.

Next steps
Depending on any other requirements for the knowledge bases, you may be asked to help with additional tasks, such as configuring knowledge homepages.

Using guided setup to implement Knowledge Management
Knowledge Management guided setup provides a sequence of tasks that help you configure Knowledge Management on your instance. To open Knowledge Management guided setup, navigate to Knowledge > Administration > Guided Setup.
For more information about using the guided setup interface, see Using guided setup.

Domain separation and Knowledge Management
This is an overview of domain separation and Knowledge Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview
Support: Level 2
Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.
Domain separation works differently at different access levels of an application. In Knowledge Management, data, requester, and fulfiller access to knowledge bases are domain separated.

**How domain separation works in Knowledge Management**

In Knowledge Management, the following rules apply:

**Data:** At the data level of domain separation, data visibility is separated from one domain to another. Knowledge bases, user criteria, articles, categories, article feedback, article versions, article templates, and external sources are domain separated in the base system.

![](https://example.com/notes.png)

*Note:* The data in one domain cannot be seen in any other domain. For example, if you create a Knowledge Management article in a domain A using an article template which is not in domain A, the article will not be visible in domain A. Similarly, if you create a Knowledge Management article in the global domain using a template that is not in global, the article might not be visible in all the domains.

**Requester:** Requester activities are supported within tenant domains. Users can search; view; comment; and rate articles of their domain, any child domain, and global domains, if feedback is enabled and the knowledge base settings grant them read access to articles.

- Users in the global domain can access articles in all the domains if read access is granted at knowledge base and/or article level.
- Users in the parent domain can access articles in that domain, global, and all its child domains if read access is granted at knowledge base and/or article level.
- Users in the child domain can access articles in that domain and the global domain if read access is granted at knowledge base and/or article level.

**Fulfiller:** The application can be used by the Fulfiller within the tenant domains as a tenant domain-owned application. Users are allowed to author articles in knowledge bases of their domain, any child domain, and the global domain if the knowledge base has user criteria set up to grant contribute access.

- Articles are automatically saved to the user’s current domain when the article is created.
- If the `glide.knowman.allow_edit_global_articles` system property is enabled, users from a domain other than the global domain can check out and edit global articles. Otherwise, system administrators and users from a domain other than the global domain cannot check out global articles and are shown a warning message to that effect. Depending on their access, users can change their domain to the global domain to check out and edit the global articles.
- Domains of versioned articles will be maintained as per the latest article version’s domain. This includes updating the domain for `kb_version`, `kb_knowledge`, `kb_feedback`, and `sys_attachment` tables.

See [Select user criteria for a knowledge base](#) to learn how to control which users create, read, write, and retire knowledge articles within a knowledge base.

See [Select user criteria for an article](#) to learn how to control read access to users at the article level.

**Use cases**

This image demonstrates a basic domain hierarchy that is available in the base system.
## Requester use cases

<table>
<thead>
<tr>
<th>User domain</th>
<th>Knowledge base domain</th>
<th>Read user criteria domain</th>
<th>Article domain</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Global</strong></td>
<td>Global</td>
<td>Global</td>
<td>Global</td>
<td>Can view, comment, rate articles.</td>
</tr>
<tr>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td></td>
</tr>
<tr>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td></td>
</tr>
<tr>
<td>MSP domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td></td>
</tr>
<tr>
<td><strong>Parent domain (TOP)</strong></td>
<td>Global</td>
<td>Global</td>
<td>Global</td>
<td>Can view, comment, rate articles.</td>
</tr>
<tr>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td></td>
</tr>
<tr>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td></td>
</tr>
<tr>
<td>MSP domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td></td>
</tr>
<tr>
<td><strong>Child domain (TOP/ACME)</strong></td>
<td>Global</td>
<td>Global</td>
<td>Global</td>
<td>Can view, comment, rate articles.</td>
</tr>
<tr>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td></td>
</tr>
<tr>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td></td>
</tr>
<tr>
<td>MSP domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td></td>
</tr>
</tbody>
</table>
### Fulfiller Use Cases

<table>
<thead>
<tr>
<th>User Domain</th>
<th>Knowledge Base Domain</th>
<th>Contribute User Criteria Domain</th>
<th>Article Domain</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Global</td>
<td>Global</td>
<td>Global</td>
<td></td>
</tr>
<tr>
<td>Parent Domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td>Parent domain (TOP)</td>
<td></td>
<td>Can author, update, view, comment, rate articles.</td>
</tr>
<tr>
<td>Child Domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td>Child domain (TOP/ACME)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSP Domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td>MSP domain (TOP/MSP)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Known Issues

- The following AQI tables are not domain separated:
  - AQI Checklist [kb_quality_checklist]
  - Checklist Question [kb_checklist_question]
  - Article Checklist Answer [kb_article_checklist_answer]

  **Note:** The Article Checklist Answer table does not contain the Order field. The application shows the list in a random order.

- Comment provided by a user on an article is stored in article's domain instead of user domain.
Knowledge base setup guide for knowledge admins and managers

After basic Knowledge Management setup is completed, you can set up a knowledge base for users to create and publish knowledge articles.

Multiple knowledge bases can be created for different groups within your organization to share information within and between those groups.

Administrators create knowledge bases, and assign them to individual managers responsible for controlling the behavior and organization scheme of each knowledge base.

Each knowledge base contains knowledge articles that provide information for users, such as policy, release notes, or instructions for a task. Each knowledge base can also use a separate workflow for publishing and retiring articles.

Requirements

Role required: knowledge_administrator, knowledge_manager, or admin

Before you begin

Determine the following requirements for each knowledge base that you want to set up:

• Who are the knowledge base managers that are responsible for approving articles?
• Who are the users and contributors for that knowledge base? Access for these users is defined through user criteria.
• What are the categories to be used to classify articles? Will users be able to create categories?
• Will users of the knowledge base be able to create new content?
• Will Social Q&A be leveraged for this knowledge base?

What to do

Set up the knowledge base

1. Create the knowledge base.
2. Set up which users can read, create, or edit knowledge articles by selecting user criteria for the knowledge base.
3. Define the approval process for articles using workflows.
4. Define the knowledge categories that are needed for organizing articles in the knowledge base.
5. If you want to enable users to ask and answer questions in the knowledge base, activate Social Q&A.
6. If you want a custom knowledge homepage, ask your ServiceNow administrator to create it.

Next steps

Let users in your organization know that they can start creating and searching articles in the knowledge base. For details, refer users to the Knowledge Management guide for users.
If you have the knowledge_manager role, there are many other tasks that you can perform to maintain the knowledge base. You can pin articles so they are featured prominently in the search results and on homepages. You can also assign other users as managers of a knowledge base. For details, see Knowledge manager.

**Quick start tests for Knowledge Management**

Validate that Knowledge Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Knowledge Management quick start tests require activating the Knowledge Management Core plugin (com.glideapp.knowledge), the Knowledge Management Advanced Installer plugin (com.snc.knowledge_advanced.installer), and the Customer Service Management Demo Data plugin (com.snc.customerservice.demo).

<table>
<thead>
<tr>
<th>KM: Knowledge Management test suite</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Test</strong></td>
</tr>
<tr>
<td>Create a KCS template article with approval publish workflow</td>
</tr>
<tr>
<td><strong>Note:</strong> Requires Knowledge Management Advanced Installer.</td>
</tr>
<tr>
<td>Create a multi-versioned standard article with approval publish workflow</td>
</tr>
<tr>
<td><strong>Note:</strong> Requires Knowledge Management Advanced Installer.</td>
</tr>
<tr>
<td>Subscribe to a knowledge article</td>
</tr>
<tr>
<td><strong>Note:</strong> Requires Knowledge Management Advanced Installer.</td>
</tr>
<tr>
<td>Create user criteria covering canRead and canContribute for knowledge base and canRead at article level</td>
</tr>
<tr>
<td><strong>Note:</strong> Requires Knowledge Management Core.</td>
</tr>
<tr>
<td>Create a KCS article from a case</td>
</tr>
<tr>
<td><strong>Note:</strong> Requires Knowledge Management Advanced Installer and Customer Service Management Demo Data.</td>
</tr>
<tr>
<td>Test</td>
</tr>
<tr>
<td>--------------------------------------------------------------------</td>
</tr>
<tr>
<td>Subscribe to a Knowledge Base</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Create an AQI checklist, assign the AQI checklist to a knowledge base, and perform an AQI review</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Search for an article, view the article, provide feedback as not helpful, and create a feedback task on the Knowledge Management Service Portal</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Check whether the Create Article and Edit Article buttons are available on a Knowledge Feedback Task form</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Search for articles, click a pinned article, and confirm that the click rank value is added to the Knowledge Searches (ts_query_kb) table</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Assign an article to an ownership group, and then confirm that the members of the ownership group are subscribed to the article and have the edit permission.</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Configure Knowledge Management**

Configure various aspects of Knowledge Management based on the specific requirements of your organization.

The following podcast offers additional information on using Knowledge Management.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Create a knowledge base

Create a knowledge base to provide a self-service platform for users to store, share, and manage content. Configure knowledge bases into product or service categories and manage user access based on permissions. Customize workflows for publishing and retiring articles in the knowledge base.

Understand the requirements for setting up a knowledge base.

Role required: knowledge_admin or admin

1. Navigate to **Knowledge > Administration > Knowledge bases**.
2. In the Knowledge Bases list, click **New**.
3. On the form, fill in the following fields as appropriate:

<table>
<thead>
<tr>
<th>Knowledge base form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Unique name for the knowledge base.</td>
</tr>
<tr>
<td>Article Validity</td>
<td>Number of default days articles will be valid for after their created date.</td>
</tr>
</tbody>
</table>

**Note:** The **Article Validity** field is configured to set the **Valid to** date for an article. The **Valid to** date is the date this knowledge article expires. When you create an article within a knowledge base, the date value in the **Valid to** field of the article is calculated as follows: Created (sys_created_on) + Article Validity (in days). An article author or editor can select whether to keep or change the **Valid to** date (see Create a knowledge article). If the **Article Validity** field is blank, the date in the **Valid to** field date is set to January 1, 2100.

<p>| Icon | An image that provides a visual reference to describe the knowledge base. This image is displayed next to all articles from this knowledge base in the article search results page. |
| Disable commenting | Option to disable commenting. If selected, users cannot comment on articles in the knowledge base. |
| Disable suggesting | Option to disable edit suggestions. If selected, users cannot suggest edits to articles in the knowledge base. |
| Disable category editing | Option to disable editing of knowledge categories. If selected, only knowledge managers can add or edit knowledge categories for the knowledge base. |
| Checklist | Checklist to evaluate the quality of articles in the knowledge base. |
| Owner | The user responsible for the knowledge base. A knowledge base owner can assign other roles to the knowledge base. |</p>
<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manager</td>
<td>Users who perform administrative functions on the knowledge base.</td>
</tr>
</tbody>
</table>
| Publish workflow              | The workflow for publishing the articles in the knowledge base.  
  - **Knowledge - Instant Publish**: publishes articles in the knowledge base without requiring an approval.  
  - **Knowledge - Approval Publish**: requests approval from the manager of the knowledge base before moving the articles to the published state. |
| Retire workflow               | The workflow for retiring the articles in the knowledge base.  
  - **Knowledge - Instant Retire**: retires articles in the knowledge base without requiring an approval.  
  - **Knowledge - Approval Retire**: requests approval from the manager of the knowledge base before moving the articles to the retired state. |
| Active                        | Option to indicate that the knowledge base is active. If not selected, only users with the admin role can create or view its articles.         |
| Enable social questions and answers | Option to enable social Q&A for articles in the knowledge base.                                                                                       |
| Description                   | A short description to describe the knowledge base.                                                                                                  |
| Set default knowledge field values | Default configuration settings for the knowledge base.                                                                                               |
| Related products              | List of products related to the knowledge base content.                                                                                              |
| Auto-create translation tasks | Option to enable creating translation tasks automatically after an article is published. If selected, when a knowledge article is published in this knowledge base, translation tasks are automatically created for the configured languages.  
  This field appears only when the translation management feature and `glide.knowman.translation.enable_translation_task` property are enabled. For more information, see Translation management and Knowledge properties. |
4. Right-click the form header and click **Save**.
5. In the related list section, view or configure the following items related to the knowledge base:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge</td>
<td>List of knowledge articles stored in this knowledge base.</td>
</tr>
<tr>
<td>Questions</td>
<td>List of Social Q&amp;A questions stored in this knowledge base.</td>
</tr>
<tr>
<td>Can Read</td>
<td>The Can Read user criteria list for this knowledge base.</td>
</tr>
</tbody>
</table>

**Note:** It is recommended to assign appropriate user criteria to secure read access. See, [Select user criteria for a knowledge base](#).

| Can Contribute | The Can Contribute user criteria list for this knowledge base. |

**Note:** It is recommended to assign appropriate user criteria to secure contribute access. See, [Select user criteria for a knowledge base](#).
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Article Templates</td>
<td>If you have activated the Knowledge Management Advanced (com.snc.knowledge_advanced) plugin, the Article Templates related list is displayed. If there are article templates in the related list, articles in that knowledge base can only be created using one of the article templates listed. If the Article Templates related list is empty, articles can be created using any article template. Click Edit to map article templates to the knowledge base.</td>
</tr>
</tbody>
</table>

**Note:** Admins, knowledge admins, and knowledge managers can edit the article templates for the knowledge base.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Featured Content</td>
<td>List of knowledge articles that appear in the homepage Featured Content section based on the corresponding keyword search set for each article.</td>
</tr>
<tr>
<td>Knowledge Categories</td>
<td>List of knowledge categories associated with this knowledge base.</td>
</tr>
</tbody>
</table>

6. Click Submit.

**Create a custom knowledge homepage**

As a system administrator, you can create a module allowing users to open a knowledge homepage for a specific knowledge base or category.

Role required: admin

1. In the application navigator, point to the application name and click the edit application icon.
2. In the Modules related list click New.
3. Enter a Title for the module.
4. In the Link type field, select URL (from Arguments).
5. In the Arguments field, append one or more of the following values to $knowledge.do#/search?.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_kb=&lt;knowledge base sys_id&gt;</td>
<td>Enter the sys_id of a knowledge base to show knowledge articles from that knowledge base by default. If the specified knowledge base does not exist, the default knowledge homepage appears when accessing the custom homepage module.</td>
</tr>
</tbody>
</table>
### Option

| **sysparm_category=<knowledge category sys_id>** | Enter the sys_id of a knowledge category to show knowledge articles from that category by default. If the specified category does not exist, the default category for the selected knowledge base appears when accessing the custom homepage module.

**Note:** The category passed in this parameter must belong to the knowledge base passed in the **sysparm_kb** parameter. |
| **sysparm_order=<view_count, last_modified, or relevancy>** | Enter the default sort order for articles to appear in. |

To create a homepage for a *Facilities* knowledge base with a **sys_id** of d582764047022100158b949b6c9a7145 and sorting by last modified date, enter `$knowledge.do#/search?sysparm_kb=d582764047022100158b949b6c9a7145&sysparm_order=last_modified` in the **Arguments** field on the Module form.

### Knowledge workflows

The publishing and retirement processes for a knowledge article are controlled by workflows defined for the knowledge base that the article belongs to.

You can assign different workflows to each knowledge base.

You can use one of the default workflows, or create your own workflows to define custom publishing and retirement processes for different types of knowledge.

For the workflows that require approval, you can configure which users can approve or reject by editing the `getApprovers()` function in the **KBWorkflow** script include.
### Default knowledge workflows

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge - Approval Publish</td>
<td>Requests approval from a manager of the knowledge base. Articles in approval are <strong>In Review</strong> state before moving to <strong>Published</strong> state once approved. If the manager rejects the request, the workflow is canceled and the article remains in <strong>Draft</strong> state.</td>
</tr>
<tr>
<td></td>
<td>If ownership groups is enabled, email notifications with a link to the article are sent to the ownership group members for approval.</td>
</tr>
<tr>
<td></td>
<td>If ownership groups is not enabled, email notifications with a link to the article are sent to knowledge base managers for approval.</td>
</tr>
<tr>
<td></td>
<td>A notification is also sent to authors or revisers of articles to inform them that their article has been approved or rejected.</td>
</tr>
<tr>
<td></td>
<td>To turn on approval email notifications, set the <code>glide.knowman.enable_approval_notification</code> property to <code>true</code>.</td>
</tr>
<tr>
<td>Knowledge - Approval Retire</td>
<td>Requests approval from a manager of the knowledge base before moving the article to the retired state. The workflow is canceled and the article remains in the published state if any manager rejects the request.</td>
</tr>
<tr>
<td>Knowledge - Instant Publish</td>
<td>Immediately publishes a draft article without requiring an approval.</td>
</tr>
<tr>
<td>Knowledge - Instant Retire</td>
<td>Immediately retires a published article without requiring an approval.</td>
</tr>
<tr>
<td>Knowledge - Publish Knowledge</td>
<td>A subflow that moves the knowledge article to the published state. You can use this subflow when defining your own workflow.</td>
</tr>
<tr>
<td>Knowledge - Retire Knowledge</td>
<td>A subflow that moves the knowledge article to the retired state. You can use this subflow when defining your own workflow.</td>
</tr>
</tbody>
</table>

**Note:**

- Retired knowledge articles are not available to users except for administrators and knowledge administrators who can view them. To reuse a retired article, administrators and knowledge administrators can republish the article. For more information, see Republish a retired article.
- An article and its translations have a parent-child relationship. Retiring a parent article does not automatically retire all its translated child articles.

### Email notifications for approval workflows

You can send email notifications for approval workflows.
• Notify approvers about knowledge articles submitted for their approvals.
• Notify authors about the approval status of their knowledge articles.

To send email notifications for approval workflows, enable the **Send notification to approvers and authors in article approval workflow** property (**glide.knowman.enable_approval_notification**). Beginning with New York, the property is enabled by default. Existing customers on release versions prior to New York can enable this property to send email notifications. Disable any custom notifications for article approvals before enabling this property. If the **glide.knowman.enable_approval_notification** property is not available, an administrator can create the property and set its value to `true`. For more information, see Knowledge properties.

**Activate the Knowledge Management Advanced plugin**

Activate the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) to enable advanced features for Knowledge Management.

Role required: admin

The Knowledge Management Advanced plugin includes feature code and demo data.

The Knowledge Management Advanced Installer plugin (com.snc.knowledge_advanced.installer) is used to activate the Knowledge Management Advanced plugin.

**Note:** The Knowledge Management Advanced plugin is not automatically activated with the Knowledge Management v3 application.

The Knowledge Management Advanced Installer plugin performs two validation steps prior to activation.

• Determines if there are any active Knowledge Management v2 knowledge bases.
• Determines if there is a unique database index on the **Number** field. If a unique constraint has been added to the **Number** field, the plugin activation fails. Follow the instructions listed in KB0634959 to perform corrective steps to resolve the issue.

You need access to **HI** to be able to view KB articles.

The Knowledge Management Advanced plugin activates the following features:

• **Article versioning:** Enables maintaining multiple versions of a knowledge article. For more information, see Article versioning.

  **Note:** Migrate to Knowledge Management v3 completely to use article versioning.

• **Article subscriptions:** Enables managing knowledge base and knowledge article subscriptions. For more information, see Knowledge subscriptions.

  **Note:** The Knowledge Management Advanced plugin activates the Subscriptions and Activity Feed Framework plugin (com.snc.activity_subscriptions).

• **Article quality index:** Enables maintaining consistent quality of knowledge articles within a knowledge base where articles are written by various authors. For more information, see Article quality index for knowledge management.

• **Article templates:** Enables creating article templates for consistent structure of knowledge articles. For more information, see Knowledge article templates.

• **Ownership group:** Enables creating ownership groups for knowledge articles. For more information, see Ownership groups.

• **In-context article creation:** Enables creating a knowledge article from a customer service case. For more information, see Enable creating an article from a customer service case.
ServiceNow DocVersion Now Platform capabilities

- Translation management: Enables managing translation tasks created for published knowledge articles. For more information, see Translation management.

Demo data is included as part of the Knowledge Management Advanced plugin. If the validation step performed by the Knowledge Management Advanced Installer plugin completes successfully, the Knowledge Management Advanced plugin is activated automatically. However, the demo data is not included in this activation. To load the demo data, go to the Knowledge Management Advanced plugin page, click the Load Demo Data Only related link, and then click OK.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Knowledge article templates

Article templates have pre-defined fields structured in a specific order. These templates help create a consistent structure for knowledge articles.

Using the Knowledge Article Templates feature, as a knowledge administrator (a user with knowledge_admin role), you can create article templates, add or customize fields in a template, and activate or deactivate a template.

As a security administrator (a user with security_admin role), you can configure field-level security in any template to make it visible to specific users.

As an author, you can create articles using pre-defined article templates or any newly created article templates.

Pre-defined knowledge article templates

Use either the standard template or one of the pre-defined How To, What Is, FAQ or KCS article templates.

   **Note:**
   When you upgrade Knowledge Management to Kingston or later releases, all existing articles from the earlier version automatically use the standard template of the upgraded version. For example, if you upgrade Knowledge Management from Jakarta to Kingston, all existing articles use the standard template available in the Kingston version.

   All pre-defined templates are inactive by default. If you do not activate a template, the articles automatically use the standard template. As a knowledge admin, you can activate a template by navigating to Knowledge > Administration > Article Templates. Then in the article template list, set the Active field to true for one or more templates you would like to activate.

The table below lists the fields available in each template and the name of the template table.
Pre-defined knowledge article templates

<table>
<thead>
<tr>
<th>Template name</th>
<th>Template fields</th>
<th>Maps to table</th>
<th>SEO Description Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAQ</td>
<td>• Question</td>
<td>FAQ [kb_template_faq]</td>
<td>Question</td>
</tr>
<tr>
<td></td>
<td>• Answer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How To</td>
<td>• Introduction</td>
<td>How To [kb_template_how_to]</td>
<td>Introduction</td>
</tr>
<tr>
<td></td>
<td>• Instructions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>What Is</td>
<td>• Introduction</td>
<td>What Is [kb_template_what_is]</td>
<td>Introduction</td>
</tr>
<tr>
<td></td>
<td>• Explanation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>KCS Article</td>
<td>• Issue</td>
<td>KCS Article [kb_template_kcs_article]</td>
<td>Issue</td>
</tr>
<tr>
<td></td>
<td>• Environment</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Cause</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Resolution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard</td>
<td>Text</td>
<td>kb_knowledge</td>
<td>Text</td>
</tr>
</tbody>
</table>

Activating knowledge article templates

The Knowledge Article Templates feature is activated with the Knowledge Management Advanced (com.snc.knowledge_advanced) plugin. For details, see [Activate the Knowledge Management Advanced plugin](#).

Deactivating knowledge article templates

You cannot delete an article template because article templates have an associated child table. Deleting a template would also require deleting the child table. Due to the limitations on dropping tables, article templates and template columns are explicitly made non-deletable. Instead you can disable the Knowledge Article Templates feature by clearing the **Active** check box on the Article Template form.

**Note:** The Standard template is available by default and can’t be made inactive.

Create an article template and use it to create a knowledge article

Create new article templates in addition to the pre-defined templates. Add new fields based on how you want to customize and display your content.

Role required: knowledge_admin or admin

For each new article template, a child table of the Knowledge [kb_knowledge] table is created. When you add a new field to the template, a new column is added to that table created for the template.

1. Navigate to **Knowledge > Administration > Article Templates**, and click **New**.
2. On the Article Template form, fill in fields.

   **Article Template form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the article template.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the article template.</td>
</tr>
</tbody>
</table>

   The **Active** check box is selected by default making the template available for use.

3. Right-click the form header and click **Save**.

4. In the Article Templates Field related list, add fields to the template.

   a) Click **New**.

   b) On the Article Template Field form, fill in the fields.

   **Article Template Field form**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Name</td>
<td>Title to display on the template form.</td>
</tr>
<tr>
<td>Field Type</td>
<td>Available field types:</td>
</tr>
<tr>
<td></td>
<td>• HTML</td>
</tr>
<tr>
<td></td>
<td>• String</td>
</tr>
<tr>
<td></td>
<td>• Integer</td>
</tr>
<tr>
<td></td>
<td>• Date</td>
</tr>
<tr>
<td></td>
<td>• Date and time</td>
</tr>
<tr>
<td>Order</td>
<td>Position of the field in the article page view and the article edit view.</td>
</tr>
<tr>
<td>Article Template</td>
<td>(Read-only) Name of the article template associated with this field.</td>
</tr>
<tr>
<td>Template Table</td>
<td>(Read-only) Name of the table for this template.</td>
</tr>
<tr>
<td>Template Field</td>
<td>(Read-only) Name of the template column associated with this field.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Option to make this field as mandatory. When selected, this field is required to be filled.</td>
</tr>
<tr>
<td>Expand/Collapse</td>
<td>Defines whether the template field displays as collapsed or expanded by default.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to display the field on the template.</td>
</tr>
<tr>
<td>Heading style</td>
<td>CSS formats applied to the template header. For example, to display the background of the template header in red, with a 24-px font size, Arial font family, and white text color, enter the following code: background-color:red; font-size:24px; font-family:Arial; color:white;</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field style</td>
<td>CSS formats applied to the template fields. Any CSS format applied at the field level is automatically applied to the header if not already specified in the <strong>Heading style</strong> field. For example, to display the 300px page width, 25px solid green border, 25px padding, and 25px page margin, enter the following code: <code>width:300px; border:25px solid green; padding:25px; margin:25px;</code></td>
</tr>
</tbody>
</table>

5. Optional: In the **SEO Description Tag** field, search for and add article template field name. The content in this field is used as meta description tags to search for articles created using this article template.

6. Configure the Knowledge form to display the fields that you added to the template.

   **Note:** You must have the admin role to configure the form layout. If the field is not available in the form layout, use the form designer to configure the fields.

   a) Navigate to **Knowledge > Articles > Create New**.
   
   b) Select a knowledge base, and then the newly added article template.
   
   c) Right-click the header and select **Configure > Form Layout**.
   
   d) Select and move the fields you added to the article template from the **Available** column to the **Selected** column.
   
   e) Click the up or down icon to arrange the fields in the order in which you want them to appear in the Knowledge form.
   
   f) Click **Save**.

**Note:** Authors who started a session before a template was created or activated will see the newly added template upon their next login.

If you want to search for duplicate articles when creating an article from a new template, you must configure the article template table for contextual search. On the Table Configuration form, the **Search context** field must be set to **Knowledge ML Search**. For more information, see [Configure table for a contextual search](#).

**Restrict access to fields in an article template**

Use encryption context to set field-level security in article templates and display the fields based on role permissions.

Activate the **Encryption Support plugin** to enable field-level security using an encryption context.

**Role required:** security_admin

1. Create an encryption context for the article template field to be encrypted.
   
   a) Navigate to **System Security > Field Encryption > Encryption Contexts** and click **New**.
   
   b) On the Encryption Context form, fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the encryption context.</td>
</tr>
<tr>
<td>Encryption key</td>
<td>Key used to encrypt the data. Leave this field blank to randomly generate a key. Based on the desired type of encryption, enter the exact number of characters:</td>
</tr>
<tr>
<td></td>
<td>• 16 characters for AES 128-bit</td>
</tr>
<tr>
<td></td>
<td>• 32 characters for AES 256-bit</td>
</tr>
<tr>
<td>Type</td>
<td>Type of encryption used to encrypt your data:</td>
</tr>
<tr>
<td></td>
<td>• AES 128-bit: Advanced Encryption Standard</td>
</tr>
<tr>
<td></td>
<td>• AES 256-bit: Advanced Encryption Standard using 256-bit encryption</td>
</tr>
</tbody>
</table>

**Warning:** You cannot retrieve this key from the instance. If you need access to the key, save it elsewhere before clicking Submit.

c) Click Submit.

2. Associate the article template field with the encryption context.
   b) On the Encrypted Field Configuration form, fill in the fields.

   **Encrypted Field Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table associated with the article template fields. For example, for the How to article template fields, select How To [kb_template_how_to].</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Column</td>
<td>Article template field to be encrypted. Only String, Date, Date/Time, and URL fields are supported.</td>
</tr>
<tr>
<td></td>
<td>• <strong>String and URL fields</strong>: You can add a new encryption configuration to either a parent table or a child table.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Date and Date/Time fields</strong>: You can create encrypted field configurations to encrypt existing Date and Date/Time fields. You can add a new encryption configuration to a parent table only. You cannot add a new encryption configuration to a child table.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Depending on the number of records affected by the Date and Date/Time fields you are encrypting, it may take up to a few minutes to create the encryption configuration. Make sure that you create the encryption configuration for Date and Date/Time fields when transaction volume on the instance is low.</td>
</tr>
<tr>
<td>Encryption context</td>
<td>Encryption context you created for the article template field.</td>
</tr>
<tr>
<td>Method</td>
<td>• <strong>Single Encryption Context</strong>: Enables data to be encrypted with a single encryption context only. The field is encrypted with the encryption context defined in the Encryption context field. Users that do not have the encryption context cannot view or update field values.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Multiple Encryption Contexts</strong>: Enables data to be encrypted with more than one encryption context. The field is encrypted by the encryption context of the first user to enter data. If the user has multiple encryption contexts, the context defined in the encryption context selector is used. Because the encryption context is set on a per record basis, fields in a list can have different encryption contexts. However, within a single record, the field can be encrypted by only one context.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Mass encryption is not available when using the Multiple Encryption Contexts method.</td>
</tr>
</tbody>
</table>
c) Click **Submit**.

3. Define role permissions for the encrypted field.
   a) Navigate to **User Administration > Roles**.
   b) In the **Name** column, click the link to the role you want to allow to view this field.
   c) In the **Encrypted context** field, search for and select the name of the encryption context for the article template field to apply for the selected role.

   **Note:** You may need to configure the Role form to add the **Encrypted context** field.

d) Click **Update**.

Depending on their role permissions defined for the encrypted field, users can view the field on the article template.

**Generate SEO information for articles using article templates**

Improve the searchability of knowledge articles by using the content in an article template field to generate SEO tags for articles created using that template.

Role required: knowledge_admin or admin

**Note:** If you are using the **Standard** article template, the content of the Text field is used to generate the tags.

You can define the number of characters to be used as tags in the **glide.knowman.seo.pages.meta_description.length** system property.

1. Navigate to **Knowledge > Article Templates**.
2. Select an article template.
3. In the **SEO Description Tag** field, select an article template field.
4. Click **Update**.

**Note:** You can change which article template field is used for generating SEO. Changes are applied only to knowledge articles created or updated after the change was made. To apply the update to all existing published articles created using this template, run the **Populate Meta Description on KB Articles** fix script.

**Article versioning**

Use the Knowledge Management article versioning feature to create and maintain multiple versions of a knowledge article.

Knowledge contributors can create a new version of a knowledge article from an existing published version. This existing version can be either the latest published version or an older outdated version. All changes are stored in the new version of the article and the information in the existing article remains the same.

If you import published knowledge articles from a ServiceNow instance that does not support article versioning, you must run the **Initialize Versions on Articles** fix script to enable article checkout and editing.

With the article versioning feature, a knowledge user can:
• Check out a published article and create another version.

**Note:** Only the author, knowledge base owner, and users with the knowledge_admin role can edit an article in the Draft state.

• Select a previously published (outdated) version of an article and make it current.
• Recall an article that is being reviewed.
• Retire the latest published version of an article.

There are two types of article revisions: major and minor. Minor revisions include updates to an article that has not yet been published. Major revisions include updates to an article that has been published and is available to customers. To track the different revisions, the article versioning feature introduces version numbering.

With the article versioning feature, the knowledge article number also includes the version number. All references to knowledge articles use this number format. For example, KB0010003 v2.0.

**Activation information**

The article versioning feature requires the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) to be activated and the glide.knowman.versioning.enabled property to be set to true (default value). For more information, see Activate the Knowledge Management Advanced plugin and Article versioning properties.

**Manually update customized files**

If you have customized any of the files that are updated as part of the Knowledge Management Advanced Installer plugin, these files are skipped during plugin activation and must be updated manually.

Manually update your customization to include the article versioning-related changes.

• Add the Version field to the Knowledge form layout and the Knowledge list view, if it is not already present.
• Add the outdated choice to the Workflow choice list field on the Knowledge form, if it is not already present. Keep the value as outdated because of dependencies that article versioning functionalities have on this choice.
• Update the Knowledge > My Flagged and Self-Service > My Knowledge Articles modules to include the following condition in the Filter field, if these modules do not already reflect this change: Revised by is (dynamic) me.

If you have customized any of the Knowledge Management Overview dashboard reports, these files are also skipped during plugin activation and must be updated manually.

**Article versioning changes**

Article versioning introduces new actions that allow knowledge users to create and revise versions of existing articles. It also introduces new fields and related lists to the Knowledge form, new columns to the Knowledge list, and updates to Knowledge dashboard reports.

**New user actions**

As part of creating article versions, users can:
- Check out a published article and create another version by clicking **Checkout** on the Knowledge form.

  **Note:** Only the author, knowledge base owner, and users with the knowledge_admin role can edit an article in the Draft state.

- Recall an article that is being reviewed by clicking **Recall** on the Knowledge form.
- Select a previously published article in the Outdated state and make it the current published version by clicking **Make this current** in the Knowledge form header.

  **Note:** To edit a published article without having to create a new version, make sure the `glide.knowman.versioning.enable_minor_edits` property is enabled.

### Changes to the Knowledge list

The article versioning feature adds the following to the Knowledge list:

- The **Version** column displays the article version number. The Knowledge list displays multiple versions of an article.
- The **Workflow** column includes the new **Outdated** state.

### Changes to the Knowledge form

The article versioning feature adds the following to the Knowledge form:

- The **Version** field displays the article version number.
- The **Display number** field displays a combination of the article number and the version number. For example, KB0010004 v1.02. All references to a knowledge article use this display number.
- The **Base Version** field displays the knowledge article number and version on which the current article is based.
- The **Revised By** field displays the name of the user who checked out a published article and created a new version.
- The **Article Versions** related list displays a list of all versions for an article. From this list, you can:
  - Click the **Version** to view a specific version of an article.
  - Click the **View Article** related link to see the article page view.

  **Note:** If necessary, configure the form to display the fields and the related list.

### Changes to Knowledge modules

The article versioning feature introduces the following Knowledge module changes:

- **My Knowledge Articles**
  - For a knowledge user, this module includes records for the articles authored by the user as well as records for each article revised by the user.
  - For a knowledge reviser, this module includes records for the articles published by the user as well as records for each article revised by the user.
• **My Flagged**
  
  • For a knowledge user, this module includes records for each revision made to articles authored by the user.
  • For a knowledge reviser, this module includes records for each article revised by the user.

  **Note:** Users that have customized these modules do not see these changes.

**Changes to Knowledge Management dashboard reports**

The Knowledge Management Overview dashboard reports have been updated to include article versioning-related changes when the Knowledge Management Advanced plugin is activated.

• Articles Flagged in the Last 30 Days
• Articles Marked Not Useful in the Last 30 Days
• Articles Used per Month
• Knowledge use
• Knowledge view
• Knowledge updated in past 30 days
• Knowledge flagged in past 30 days
• Knowledge by Workflow state
• Knowledge created by Author
• Knowledge created in past 30 days
• New Knowledge Articles Created in the Last 30 Days
• Knowledge Ratings for past 30 days

**Versioning information available in the Knowledge Management Service Portal**

Knowledge search results show the article number and the version number for each article.

  **Note:**
  
  To display the article version number next to the article number in the search results, enable the `glide.knowman.search.show_article_number` property in the Knowledge Search Properties section of the Knowledge Management Properties page.

  If you are accessing an article from the base system or knowledge service portals using the URL to a KB article, you must also include the article version number in the URL. For example, to access the KB00000005 knowledge article, instead of using the `https://<instance name>/sp?id=kb_article&sys_id=KB00000005` as the URL, you must use `https://<instance name>/sp?id=kb_article&sys_id=KB00000005%20V1.0` to view the article.

The article view page shows a version history section for articles that have been updated. This section includes the version numbers, date updated, and the name of the author or reviser.

• Click **Latest version** or the version number and current state to expand the version history section.
• Click the version number to open that particular version of the article.
• When viewing an outdated article, a message informs the user that a newer updated version is available. The message includes a link to the latest version.
Feedback on article versions

With the article versioning feature, users can view and contribute to feedback on the current versions of knowledge articles.

For more information about feedback options, see Knowledge feedback.

<table>
<thead>
<tr>
<th>Feedback option</th>
<th>How this option works with article versioning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rating an article</td>
<td>The average rating for an article is carried over to the checked out version. The average rating calculation updates and displays on the current version of the article.</td>
</tr>
<tr>
<td>Marking an article as helpful</td>
<td>The helpfulness percentage of a previous version of an article is also considered for a new version when displayed in the helpfulness column on the homepage.</td>
</tr>
<tr>
<td>Comments</td>
<td>The Comments section at the bottom of an article displays comments from previous versions unless Live Feed is enabled. Live Feed only shows comments for the current version.</td>
</tr>
<tr>
<td>Flagging an article</td>
<td>Checking out an article or setting a previous version to the current version resets the flagged value to false.</td>
</tr>
<tr>
<td>View count</td>
<td>The view count is carried over to the checked out article. Any view of a version of an article increments the view count of all subsequent versions. Views to a newer version of an article do not affect the view count of previous versions.</td>
</tr>
<tr>
<td>Use count</td>
<td>The use count is carried over to the checked out article. Any use of a version of an article increments the use count of all subsequent versions. Any use of a newer version of an article does not affect the use count of previous versions.</td>
</tr>
</tbody>
</table>

Knowledge article version numbers

Knowledge article version numbers follow a specific pattern. Increments to the version number depend on the revision type.

Article version numbers follow this pattern: <major release number.minor release number>

The type of revision being made to an article determines the increment. A minor revision increments the version number by 0.01. A major revision, such as publishing an article, increments the version to the next whole number, for example, from version 2.02 to 3.0.

The following example illustrates the life cycle of a versioned article and the changes to the version number.

<table>
<thead>
<tr>
<th>User action</th>
<th>Article state</th>
<th>Version number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge author creates a new article</td>
<td>Draft</td>
<td>0.01</td>
</tr>
<tr>
<td>Knowledge author makes a change and updates the article.</td>
<td>Draft</td>
<td>0.01</td>
</tr>
<tr>
<td>Knowledge author submits the article for review.</td>
<td>Review</td>
<td>0.02</td>
</tr>
<tr>
<td>Knowledge author recalls the article to make another change.</td>
<td>Draft</td>
<td>0.03</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Knowledge article states

A versioned knowledge article can be in one of several states as it progresses through the creation cycle.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>The article is in the process of being created.</td>
</tr>
<tr>
<td>Review</td>
<td>The draft version of the article is sent to reviewers to approve or reject.</td>
</tr>
<tr>
<td>Published</td>
<td>The article is approved and published. When the state of an article changes to <strong>Published</strong>, the state of any previous published versions of that article changes to <strong>Outdated</strong>.</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pending retirement</td>
<td>The published article is selected for retirement, pending approval.</td>
</tr>
<tr>
<td>Retired</td>
<td>The published article is retired. Retired knowledge articles cannot be searched for by external users or customers. To reuse a retired article, create a new article with the same content, which is published once approved.</td>
</tr>
<tr>
<td>Outdated</td>
<td>A more recent version of the article has been published. End users can read published articles as well as the outdated versions.</td>
</tr>
</tbody>
</table>

**Check out a published article and create a new version**

Create a new version of a knowledge article by checking out the latest published version.

Users with canContribute permissions, including the knowledge owner, knowledge manager, and knowledge administrator, can check out a published article unless there is already a checked out version. If a version has been checked out, the **Checkout** button does not appear on the Knowledge form header.

When you check out an article, the default value of **Valid to** field of the article is derived from the **Article Validity** field configured for the knowledge base (see [Create a knowledge base](#)). If the **Article Validity** field is blank, the date in the **Valid to** field date is set to January 1, 2100. An article author or editor can select whether to keep or change the default **Valid to** date.

When you check out an article, attachments from the article’s base version are copied into the new article version and relative paths to these attachments are also updated.

**Note:** For article versions that were created in the previous releases, the relative paths to the attachments may not be updated. To update them, activate and run the **Fix attachment links on article versions** fix script.

1. Navigate to **Knowledge > Articles > Published**.
2. Select the desired article from the list.
3. Click **Checkout** in the Knowledge form header.
   The system creates a new version of the knowledge article and displays a message to the user. The article number for the new version remains the same, the version number is increased by 0.01, and the state changes to **Draft**. The new version of the article is added to the Knowledge list and to the **Article Versions** related list on the Knowledge form.

**Approve an article that is being reviewed**

Approve an article that is being reviewed and create a new published version.

When an article is in the **Review** state, only those users who are included in the **Approvals** related list can modify the article.

1. Navigate to **Knowledge > Articles > Unpublished**.
2. Open an article in the **Review** state and review the text.
3. In the **Approvals** related list, click **Requested** in the **State** column to display the Approval form for the article.
4. Click **Approve**.
   The system displays the Knowledge form. The version number of the article increments to the next whole number (for example, from 2.02 to 3.0) and the state changes to **Published**. The new published version is added to the Knowledge list and to the **Article Versions** related list on the Knowledge form.
version of the article is added to the Knowledge list and to the Article Versions related list on the Knowledge form.

Revert an outdated article to the current state

Use an outdated version of an article to create a new version.

Roles required: knowledge base owner, knowledge_manager, knowledge_admin

This action is available for earlier published version that have a state of Outdated and only when there is no checked out version. If a version has been checked out, the Make this current button does not appear on the Knowledge form header.

1. Navigate to Knowledge > Articles > All.
2. Open an article in the Outdated state.
3. Click Make this current in the Knowledge form header.
   The system displays the Knowledge form. The version number increments to the latest version number plus 0.01 and the state changes to Draft. For example, if the latest published version of an article is 3.0 and you select the outdated 1.0 version to become the current version, the version number increments to 3.01.

Recall an article that is being reviewed

Recall an article that is being reviewed to make additional changes.

If ownership groups is not enabled, only the author of the article, knowledge administrators, or system administrators can recall the article.

If ownership groups is enabled, the author of the article, the ownership group manager, ownership group members, knowledge administrators, or system administrators can recall an article.

Recalling an article in the Review state results in a minor version increment.

When a revised article is in Review state, only the corresponding versions reviser can recall the article to make additional changes.

1. Navigate to Knowledge > Articles > All.
2. Open an article in the Review state.
3. Click Recall in the Knowledge form header.
   The system returns the state of the article to Draft, increments the version number by 0.01, and displays a message to the user.

View all versions of an article

View a list of all available versions for a selected knowledge article and then view the selected version in a new tab.

The list of all available versions for a selected knowledge article is displayed in the Article Versions related list on the Knowledge form. Users with read access can see major versions. Users with contribute access can see major and minor versions.

1. Navigate to Knowledge > Articles > All.
2. Open the desired article.
3. Click the Article Versions tab to display the related list.
4. Click Version to display the desired article version in a new tab.
5. If desired, click the View Version related link to see the article view page.

Compare two versions of an article

Select and compare two versions of a knowledge article.
Role required: knowledge_manager, knowledge_admin

1. Navigate to a Knowledge > Articles > All.
2. In the Name column, click the link to a knowledge article with multiple versions.
3. In the Article Versions related list, select the check boxes for the two versions of the article to compare.
4. Scroll down to the Actions on related rows menu and choose Compare. The Compare versions page opens and lists the fields for the selected article versions in a side-by-side format. Differences between the two article versions are highlighted.

5. When you are finished comparing the two versions, click Done to return to the Knowledge form.

Retire a versioned article

You can retire the latest published version of a knowledge article. Retiring a knowledge article does not create a new version. It simply marks the article as Retired.

This action is available only when there is no checked out version. If a version has been checked out, the Retire button does not appear on the Knowledge form header.

Note: For the Knowledge - Approval Retire workflow, this happens only when the retire request is approved.

In addition to the knowledge administrator and the knowledge manager, the following users can retire a versioned article:

- knowledge owner
- latest publisher of the versioned knowledge article

Users can still access outdated articles that have been attached to incidents by navigating to the article view page with the sys_id of the article. Outdated articles include a message that an updated article is available.
If versioning is disabled, only the latest version of the article is shown in search results and list views. Retired knowledge articles cannot be searched for by external users or customers. To reuse a retired article, create a new article with the same content, which is published once approved.

1. Navigate to Knowledge > Articles > Published.
2. Open the desired article.
3. Click Retire in the Knowledge form header.

The system returns to the Knowledge list. The state of the article changes to Pending retirement and the state of previously published versions change to Outdated.

Note: You cannot check out or edit a retired article.

Disable the article versioning feature

Users with the system administrator role can disable the article versioning feature by setting a property.

Role required: admin

The Enable article versioning feature property controls the article versioning feature. Setting this property to false disables the article versioning feature. Once disabled:

- The Version field is removed from the Knowledge form. The Version column remains on the Knowledge list and can be removed manually.
- The Article Versions related list is removed from the Knowledge form.
- The Recall, Checkout, and Make this current buttons are removed from the Knowledge form.
- Outdated articles are removed from Knowledge list views.
- The version history does not appear on the article view page.

Articles continue to be versioned in the background. Minor versions are incremented until an article is published and then the version number is increased to the next major version.

Users can still access outdated articles that have been attached to incidents. Outdated articles include a message that an updated article is available.

1. Navigate to Knowledge > Administration > Properties.
2. Locate the Enable article versioning feature property in the Article Versioning Properties section.
3. Click the check box to disable the property.
4. Click Save.

Knowledge manager

Having multiple knowledge bases allows an organization to spread management responsibilities across multiple users, known as knowledge managers.

As a knowledge manager, you can assign other managers, define category structures, configure which users can read and contribute articles, move and pin articles, and modify most fields on the Knowledge Base form. You can also approve the publishing or retiring of knowledge articles in those knowledge bases. You can enable Social Q&A for your knowledge bases if the Social Q&A application is active.

The primary manager of a knowledge base is the owner of that knowledge base. Each knowledge base must have one owner. There may be any number of additional managers for each knowledge base. The owner and all managers of a knowledge base automatically receive the knowledge_manager role. If the knowledge base is made inactive later, the knowledge_manager role is not automatically removed for these users.
Add a knowledge article to featured content

Add a knowledge article to appear in the Featured content section of the knowledge homepage and at the top of knowledge search results page.

Role required: knowledge_manager, knowledge_admin, or admin

Adding an article to featured content requires associating an article to specific keywords. You can search a keyword in the knowledge service portal or search results page to display articles in the Featured content section or at the top of the knowledge search results list.

Note: The articles added to the Featured content section do not appear in the global search results and Virtual Agent conversations.

- To display articles in the Featured content section, add a default keyword in the `glide.knowman.default_keyword` property `Value` field and add the same keyword to all articles you want to display in that section.
- To display articles at the top of the knowledge search results list, add a list of keywords to each article you want to display at the top of the list.

1. Navigate to Knowledge > Knowledge Bases.
2. Select a knowledge base.
3. In the Featured content related list, click New.
4. In the Knowledge field, search for and select the desired article.
   If you know the article number, you can search for the article directly.
5. In the Keywords field, click the lock/unlock toggle icon.
6. Click the lookup icon to open the Knowledge keywords list.

Note: Each keyword must be a single word and cannot contain spaces.

7. Select the keyword to add for this article.
   - Add the default keyword to display this article in the Featured content section during search.
   - Add all related keywords for the article to display it at the top of the knowledge search results page during search.

Note: You can create knowledge keywords, if it does not already exist in the list, and then add it to the article.

8. Click the lock/unlock toggle icon to add the keywords to the article.
9. Click Submit.

Create a user criteria record in Knowledge Management

You can create or modify a user criteria record in Knowledge Management. User criteria is used to control which users, groups, roles, companies, locations, and/or departments can access knowledge bases and articles.

Role required: user_criteria_admin

1. Navigate to Knowledge > Administration > User Criteria.
2. Click New or open a record.
3. Fill out the fields on the form as required. For field descriptions, refer to Create a user criteria record in Service Catalog

Note: Including scripts in user criteria records can impact performance, because scripts are evaluated dynamically.

If scripted user criteria is defined for a knowledge base, user access to knowledge bases is evaluated once per session. If the script results in changes after a session cache is built, the result takes effect in the next session.

Changes to a user role, group, company, location, or department take immediate effect.

4. Click Submit.

Select user criteria for a knowledge base

You can specify user criteria to control which users can create, read, and write knowledge articles within a knowledge base.

Role required: knowledge_manager, knowledge_admin, or admin

User criteria refers to knowledge base records that determine the users who can read or contribute to a knowledge base. Users who have write access can also initiate the retirement workflow for an article. So, indirectly user criteria control who can submit an article for the retirement workflow.

User criteria definitions:

- **canRead**
  users who can read all knowledge base articles

- **cantRead**
  users who cannot read, create, or modify articles in the knowledge base

- **canContribute**
  users who can read, create, and modify articles in the knowledge base

- **cantContribute**
  users who cannot create or modify articles in the knowledge base

If a knowledge base has no user criteria defined, all users (including unauthenticated users) can read its articles. Any user having at least one role can create and edit articles, unless they are members of the **cantContribute** user criteria. If a knowledge base has **canRead** user criteria, but no **canContribute** user criteria, all users with at least one role can access and modify the knowledge base.

Explicit roles (snc_external and snc_internal) are added to your instance when you install a plugin, such as the Customer Service plugin (com.sn_customerservice), that also activates the Explicit Roles plugin. If you create a new knowledge base with the Explicit Roles plugin active, only users with the snc_internal role can access the knowledge base. To make all existing knowledge bases that do not have the **canRead** or **canContribute** user criteria accessible only to users with the snc_internal role, activate and run the **Fix unsecured knowledge bases** fix script.

If the Any User user criteria is associated with a knowledge base, only users with at least one role can view the article within the knowledge base.

Users with special privileges are evaluated based on user criteria and have access to knowledge bases and knowledge articles access.
### Access of users with special privileges to knowledge bases and knowledge articles

<table>
<thead>
<tr>
<th>User</th>
<th>Access</th>
</tr>
</thead>
</table>
| Knowledge administrator                          | • Contribute to and read all knowledge bases and their articles.  
• Modify the definition of all knowledge bases and assign user criteria to them. |
| Owner of a knowledge base                        | • Contribute to and read that knowledge base.  
• Modify the definition of that knowledge base and assign user criteria to it. |
| Manager of a knowledge base                      | • Contribute to and read that knowledge base.  
• Modify the definition of that knowledge base and assign user criteria to it. |
| Members of an ownership group associated with a knowledge article | Read, modify, and retire that knowledge article.                                                                                     |

**Note:** If the knowledge article versioning feature is enabled, the manager of a knowledge base can’t modify knowledge articles of other authors that are in the **Draft** state.

When the Can Contribute user criteria for a knowledge base isn't set, the `glide.knowman.block_access_with_no_user_criteria` property value is further evaluated to determine contribute access, as explained in the following table.

#### Contribute access when Can Contribute for a knowledge base isn't set

<table>
<thead>
<tr>
<th>Property value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>No user has contribute access to the knowledge base except users with special knowledge privileges.</td>
</tr>
<tr>
<td>false</td>
<td>Users with at least one role can contribute to the knowledge base.</td>
</tr>
</tbody>
</table>

**Note:** If the Explicit Roles plugin is activated, users who have at least one role other than snc_internal can contribute to the knowledge base.

When the Can Read user criteria for a knowledge base isn't set, the `glide.knowman.block_access_with_no_user_criteria` property value is further evaluated to determine read access, as explained in the following table.
Read access when Can Read for knowledge base isn’t set

<table>
<thead>
<tr>
<th>Property value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>No user has read access except users with special knowledge privileges and users who have contribute access to the knowledge base.</td>
</tr>
<tr>
<td>false</td>
<td>All users, including unauthenticated users, have read access to the knowledge base and the article-level user criteria are further evaluated. For more information about article-level user criteria, see Select user criteria for an article.</td>
</tr>
</tbody>
</table>

This video demonstrates how to control Knowledge Management access through user criteria.

**Important:** After making user criteria additions or changes, you may need to log out and back in to clear the prior configuration.

1. Navigate to **Knowledge > Knowledge Bases**.
2. Select a knowledge base you manage.
3. Access one of these related lists, and then select or create user criteria records. For information about user criteria fields, see **User criteria fields**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can read</td>
<td>Users who meet one of these criteria can read articles in this knowledge base.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Can contribute</td>
<td>Users who meet one of these criteria can create and edit articles in this knowledge base.</td>
</tr>
</tbody>
</table>
Can Read
Leveraging User Criteria to grant read access to Knowledge Bases & Knowledge Articles

- User role: admin, knowledge_admin, KB-owner, KB-manager, CanContribute
  - No
  - User has Cannot Read role
    - Yes → No Access to KB and/or Article(s)
    - No → User has Can Read role, or KB requires no role
      - Yes → Can Read KBs and/or Article(s)
      - No
Can Contribute
Leveraging User Criteria to grant access to Knowledge Bases & Knowledge Articles

User role: admin, knowledge_admin, KB-owner, KB-manager

No

User has cantContribute role

Yes → No Access to KB and/or Article(s)

No

User has canContribute role, or KB requires no role

No

Yes → Can Contribute to KB and/or Article(s)
### Order of System Validation (L->R)

<table>
<thead>
<tr>
<th>Contribute</th>
<th>Read</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>cantContribute (1)</td>
<td>canContribute (2)</td>
<td>cantRead (3)</td>
</tr>
<tr>
<td>empty</td>
<td>empty</td>
<td>empty</td>
</tr>
<tr>
<td>empty</td>
<td>empty</td>
<td>empty</td>
</tr>
<tr>
<td>empty</td>
<td>empty</td>
<td>User B</td>
</tr>
<tr>
<td>empty</td>
<td>empty</td>
<td>User B</td>
</tr>
<tr>
<td>empty</td>
<td>empty</td>
<td>User B</td>
</tr>
<tr>
<td>empty</td>
<td>empty</td>
<td>User B</td>
</tr>
<tr>
<td>empty</td>
<td>empty</td>
<td>User B</td>
</tr>
<tr>
<td>Contribute</td>
<td>Read</td>
<td>Result</td>
</tr>
<tr>
<td>-----------</td>
<td>------</td>
<td>--------</td>
</tr>
<tr>
<td>cantContribute (1)</td>
<td>canContribute (2)</td>
<td>cantRead (3)</td>
</tr>
<tr>
<td>empty</td>
<td>User C</td>
<td>empty</td>
</tr>
<tr>
<td>empty</td>
<td>User C</td>
<td>User B</td>
</tr>
<tr>
<td>empty</td>
<td>User C</td>
<td>empty</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
<table>
<thead>
<tr>
<th>Contribute</th>
<th>Read</th>
<th>Result</th>
<th>Permissions on KB (in the following order)</th>
</tr>
</thead>
<tbody>
<tr>
<td>cantContribute (1)</td>
<td>canContribute (2)</td>
<td>cantRead (3)</td>
<td>canRead (4)</td>
</tr>
<tr>
<td>User D</td>
<td>User A</td>
<td>empty</td>
<td>1. User D -&gt; Denied Create, Read</td>
</tr>
<tr>
<td></td>
<td></td>
<td>empty</td>
<td>2. All Other Users with role -&gt; Create</td>
</tr>
<tr>
<td></td>
<td>User B</td>
<td></td>
<td>3. User A -&gt; Read</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. All Users with role -&gt; Read</td>
</tr>
<tr>
<td>User D</td>
<td>User B</td>
<td>empty</td>
<td>1. User D -&gt; Denied Create</td>
</tr>
<tr>
<td></td>
<td>User A</td>
<td></td>
<td>2. All Other Users with role -&gt; Create</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. User B -&gt; Denied Read</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. All Users (including unauthenticated users) -&gt; Read</td>
</tr>
<tr>
<td>User D</td>
<td>User B</td>
<td>User A</td>
<td>1. User D -&gt; Denied Create, Read</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. All Other Users with role -&gt; Create</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. User A -&gt; Read</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. All Users with role -&gt; Read</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. User B -&gt; Denied Read</td>
</tr>
<tr>
<td>Contribute</td>
<td>Read</td>
<td>Result</td>
<td>Permissions on KB (in the following order)</td>
</tr>
<tr>
<td>------------</td>
<td>------</td>
<td>--------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>cantContribute (1)</td>
<td>canContribute (2)</td>
<td>cantRead (3)</td>
<td>canRead (4)</td>
</tr>
<tr>
<td>User D</td>
<td>User C</td>
<td>empty</td>
<td>empty</td>
</tr>
<tr>
<td>1. User D -&gt; Denied Create</td>
<td>2. User C -&gt; Create, Read</td>
<td>3. All Users (including unauthenticated users) -&gt; Read</td>
<td></td>
</tr>
<tr>
<td>User D</td>
<td>User C</td>
<td>empty</td>
<td>User A</td>
</tr>
<tr>
<td>1. User D -&gt; Denied Create, Read</td>
<td>2. User C -&gt; Create, Read</td>
<td>3. User A -&gt; Read</td>
<td></td>
</tr>
<tr>
<td>User D</td>
<td>User C</td>
<td>User B</td>
<td>empty</td>
</tr>
<tr>
<td>1. User D -&gt; Denied Create</td>
<td>2. User C -&gt; Create, Read</td>
<td>3. User B -&gt; Denied Read</td>
<td>4. All Other Users -&gt; Read</td>
</tr>
<tr>
<td>User D</td>
<td>User C</td>
<td>User B</td>
<td>User A</td>
</tr>
</tbody>
</table>

**Note:** In the tables of rules, an implicit last rule is: All Users -> Denied Create, Read.

**Enable user criteria system property to override role read access**

Add the glide.knowman.search.apply_role_based_security system property to enable user criteria to control read access of knowledge bases or articles over roles.
Role required: admin

1. Follow the steps to Add a system property.
2. Add the `glide.knowman.search.apply_role_based_security` property, and set the property value to `false`. This enables specified user criteria to override `canRead` access specified for roles.

Select user criteria for an article

You can specify user criteria for an article to control which users can read the article.

If an article has no user criteria selected, the article is available to all users, including unauthenticated users, who have access to that knowledge base (based on the user criteria for the knowledge base). Knowledge base user criteria restrictions override article-level user criteria. For example, a knowledge base that is configured to restrict user access overrides any access granted at the article level.

If a user has contribute access to the knowledge base, article-level user criteria are not evaluated and the user can read all articles in the knowledge base. If a user has read access to the knowledge base, article-level user criteria are evaluated to determine if the user has read access to the article.

On the article level, if Can read user criteria is defined, only those users specified can read the article. If an article has Cannot read user criteria defined, those users specified are denied reading the article. Cannot read user criteria overrides Can read user criteria for articles.

If the Any User user criteria is associated with an article, only users with at least one role can view the article.

1. Navigate to Self-Service > My Knowledge Articles.
2. Select an article.
3. Select the desired user criteria for the Can Read and Cannot Read fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can Read</td>
<td>Users who meet one of these criteria can read the article.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cannot Read</td>
<td>Users who meet one of these criteria are denied reading the article (regardless of the Can Read setting for the user).</td>
</tr>
</tbody>
</table>

**Note:** If the Can Read and Cannot Read fields are not visible, add the fields to the form by configuring the form layout (click the form context menu icon and select Configure > Form Layout).
<table>
<thead>
<tr>
<th>Knowledge base level Access</th>
<th>Article level Read</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contribute</td>
<td>cantRead</td>
<td>canRead</td>
</tr>
<tr>
<td>Yes</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>empty</td>
</tr>
<tr>
<td></td>
<td>empty</td>
<td>empty</td>
</tr>
<tr>
<td></td>
<td>User</td>
<td>empty</td>
</tr>
<tr>
<td></td>
<td>User</td>
<td>User</td>
</tr>
</tbody>
</table>

**Note:**
- When article-level read access is assigned to an article, only the user who belongs to that particular user criteria can read the article. Other users are restricted.
- Users with contribute access to a knowledge base can also read articles even if they are not in the defined Can Read user criteria.
- Ownership group users who are either members or managers of groups assigned to an article will have access to contribute to articles even if they don’t have contribute access to the knowledge base.

**Define a knowledge article category**

Each knowledge base has a hierarchy of categories that organizes the articles.

You must have CanContribute access to the knowledge base or have a knowledge_admin or admin role.

Define a hierarchy for categories by creating parent-child relationships. Each hierarchy consists of a top-level category and a structure of subcategories, which are also named the child categories. The category hierarchy is saved in the Full category field in the Knowledge Category [kb_category] table.

You can create and edit categories separately for each knowledge base.

1. Navigate to Knowledge > Administration > Knowledge Bases.
2. Select a knowledge base you manage.
3. Create a top-level category.
   a) In the Knowledge Categories related list, click New.
   b) On the Knowledge Category form, fill in the fields.

**Knowledge Category form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Label for the category. The label appears as the name of the category.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Value</td>
<td>Value for the category you use when referencing the category in scripts.</td>
</tr>
<tr>
<td>Parent ID</td>
<td>Top-level component associated with the category.</td>
</tr>
<tr>
<td></td>
<td>This field is automatically set to the top-level component ID.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to enable the category.</td>
</tr>
</tbody>
</table>

c) Click Submit.

4. Optional: Create a child category.
   a) Expand an existing category and click New within the expanded section.
   b) Fill in the Knowledge Category form.
   c) Click Submit.

In addition to using categories defined by a knowledge manager, knowledge contributors can add and edit categories when editing an article.

**Assign a knowledge base manager**

You can assign users as managers of a knowledge base.

Role required: knowledge_admin, or admin

1. Navigate to Knowledge > Knowledge Bases.
2. Select a knowledge base you manage.
3. In the Managers field, click the unlock icon.
4. Add one or more users.
5. Click Update.

After you save the knowledge base record, users selected as managers automatically receive the knowledge_manager role if they do not have it already.

You can remove a knowledge base manager by removing that user from the Managers field. If the user is not a manager of any other knowledge base, the knowledge_manager role is removed from that user.

**User criteria diagnostics for Knowledge Management**

Manage user access to a knowledge base or an article using user criteria diagnostics. Understand what access users have to a knowledge base or an article and determine which user criteria define those permissions.

User access to a knowledge base or an article can be restricted based on:

- Domain separation
- Access control list (ACL) rules
- Knowledge workflows
- User criteria set for a knowledge base or an article

This feature considers domain separation and user criteria to determine the user access to knowledge bases and articles.
Activating user criteria diagnostics

The user criteria diagnostics feature is activated with Knowledge Management v3 (com.snc.knowledge3) plugin.

Diagnose user access to a knowledge base

Identify which users have access to a knowledge base and what enables that access.

Role required: knowledge_manager, knowledge_admin, or admin

1. Access the **User Criteria Diagnostics** landing page using one of these options:

<table>
<thead>
<tr>
<th>To access</th>
<th>Navigate to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the application navigator</td>
<td>Knowledge &gt; Administration &gt; User Criteria Diagnostics</td>
</tr>
<tr>
<td>From a knowledge base</td>
<td>a. Knowledge &gt; Administration &gt; Knowledge Bases.</td>
</tr>
<tr>
<td></td>
<td>b. Select the knowledge base to diagnose user access.</td>
</tr>
<tr>
<td></td>
<td>c. In the Related Links section, click Run User Criteria Diagnostics.</td>
</tr>
</tbody>
</table>

The **User Criteria Diagnostics** landing page appears with the Select knowledge base field pre-populated.

2. To diagnose user access:
   a) In the **Select user** field, select a user.
   b) From the **Select record type** choice list, select **Knowledge base**.
   c) In the **Select knowledge base** field, select a knowledge base.
      Every time you select a different user, record type, or knowledge base, the page refreshes and displays data for the selected user.
   d) Click **Diagnose**.
      The page displays these details:
      - Whether the user has access to the knowledge base based on their domain. Only system administrators can view domain information and change the domain to give access to a user.
      - Which user criteria provides read or read and contribute access for this user to the knowledge base and what type of user criteria definition enables this access.
      - Whether a role that the user has (knowledge_manager, knowledge_admin, or owner of the knowledge base) enables this access.
      - For a user with no access to this knowledge base, which user criteria may be modified to grant the access.

The following image shows an example of a diagnosis where the user Alene Reback does not have access to the IT knowledge base.

Alena can get access to the knowledge base if:

- Alena is added to one of the existing user criteria defined in the knowledge base.
- Alena is added to a new user criteria that is defined and added to the knowledge base.

Click the IT knowledge base link and provide the access by adding Alena to a user criteria for this knowledge base.
User Criteria Diagnostics

- Select user: Alene Rabeck
- Select record type: Knowledge Base
- Select knowledge base: IT

No Access

Alene Rabeck does not have access to knowledge base (IT).

⚠️ If ACLs were applied to this Knowledge Base, the ACLs will override the permissions defined by user criteria.

How to Provide Access

To provide access to knowledge base (IT), add Alene Rabeck to one or more of the following user criteria.

<table>
<thead>
<tr>
<th>User Criteria</th>
<th>Access Type</th>
<th>Set on</th>
</tr>
</thead>
<tbody>
<tr>
<td>The ACME North America IT Department</td>
<td>Can Contribute</td>
<td>Knowledge Base</td>
</tr>
<tr>
<td>All ACME North America employees</td>
<td>Can Read</td>
<td>Knowledge Base</td>
</tr>
<tr>
<td>All ACME Corporation employees</td>
<td>Can Read</td>
<td>Knowledge Base</td>
</tr>
</tbody>
</table>

1 to 3 of 3 results
Diagnose user access to an article

Identify which users have access to an article and what enables that access.

Role required: knowledge_manager, knowledge_admin, or admin

1. Access the **User Criteria Diagnostics** landing page using one of these options:

<table>
<thead>
<tr>
<th>To access</th>
<th>Navigate to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the application navigator</td>
<td>Knowledge &gt; Administration &gt; User Criteria Diagnostics.</td>
</tr>
<tr>
<td>From an article</td>
<td>a. Knowledge &gt; Administration &gt; Knowledge Bases.</td>
</tr>
<tr>
<td></td>
<td>b. Select the knowledge base that has the article to diagnose for user access.</td>
</tr>
<tr>
<td></td>
<td>c. In the Knowledge related list, select the article.</td>
</tr>
<tr>
<td></td>
<td>d. In the Related Links section, click Run User Criteria Diagnostics.</td>
</tr>
</tbody>
</table>

The **UserCriteria Diagnostics** landing page appears with the **Select article** field pre-populated.

2. To diagnose user access:
   a) In the **Select user** field, select a user.
   b) From the **Select record type** choice list, select **Article**.
   c) In the **Select article** field, select an article.
      
      Every time you select a different user, record type, or knowledge base, the page refreshes and displays data for the selected user.
   d) Click **Diagnose**.

   The page displays these details:
   - Whether or not the user has access to the knowledge article based on their domain. Only system administrators can view domain information and change the domain to give access to a user.
   - Which user criteria provides read or read and contribute access for this user to the article and what type of **user criteria definition** enables this access.
   - Whether a role of the user has (knowledge_manager, knowledge_admin, or owner of the knowledge base) enables this access.
   - For a user with no access to this article, which user criteria may be modified to grant the access.

   **Note:** Members of an ownership group are automatically given **Can Contribute** access to knowledge articles that their ownership group is associated with.

The following image shows an example of a diagnosis where the user Adela Cervantsz has read access to the KB article, KB0000001 v5.0, in the IT knowledge base because Adela belongs to one of the **Can Read** user criteria defined in the knowledge base.
### User Criteria Diagnostics

| Select user  | Adela Cervantsz |
| Select record type | Article |
| Select article | KB00000001 v1.0 |

### Read Access

No user criteria is configured at article level. Adela Cervantsz has Read access to article KB0000001 in knowledge base IT, because the user has Read access to the knowledge base.

⚠️ If ACLs were applied to this Article, the ACLs will override the permissions defined by user criteria.

⚠️ The article's publication status may also impact the user's access to it. If diagnostic results conflict with the user's access, please check the publication status of the article.

### User Criteria Assigned

<table>
<thead>
<tr>
<th>User Criteria</th>
<th>Access Type</th>
<th>Set on</th>
</tr>
</thead>
<tbody>
<tr>
<td>All ACME North America employees</td>
<td>Can Read</td>
<td>Knowledge Base</td>
</tr>
<tr>
<td>All ACME Corporation employees</td>
<td>Can Read</td>
<td>Knowledge Base</td>
</tr>
</tbody>
</table>

1 to 2 of 2 results
**I18N - Knowledge internationalization**

Organizations with knowledge users who speak multiple languages can activate the optional knowledge internationalization features.

Activating internationalization plugins for any of the available languages automatically activates the I18N: Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2).

When active, knowledge internationalization enables the knowledge management team to create language-specific knowledge articles and keep translations of the same article related to each other so they are easy to manage. Users can view and search within their own language while still being able to view articles in other languages when necessary.

**Note:**

To set the default language for searching articles to a language different from the logged in language of the user, specify the desired language in the glide.knowman.search.default_language system property. For example, if you are logged in using the French language and would like the default language for searched articles to be English, specify English in the system property. You can then switch to French from within the UI to see French articles. If no language is specified in the system property, articles default to the logged in language of the user.

To enable search for different languages simultaneously, navigate to Knowledge Administration > Knowledge Search > Properties > Enable multi language search. Select the Yes check box to enable the feature.

**Note:** If you do not enable this property, you can search in one language at a time. If the property is enabled, you can search for multiple languages simultaneously.

Refer to Search using Knowledge Management v3 for information on performing a search on all available languages simultaneously.

Social Q&A does not use language-specific questions and answers. All questions and answers appear in the language they were created in. For example, a question in English is not translated when the current user’s selected language is French.

**Activate the knowledge management internationalization plugin**

To enable translation of knowledge articles, you must activate multiple plugins.

- I18N:Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2). For more information, see Activate a plugin.
- Internationalization plugins for each appropriate language. For more information, see Activate a language

**Note:** Activating internationalization plugins for any of the available languages automatically activates the I18N: Internationalization plugin (com.glide.i18n) that instead activates the I18N: Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2).

**Installed Components**

Activating the Knowledge Management Internationalization plugin installs these components:

- A relationship named Translated Versions that creates a related list on the Knowledge form showing other articles that have the same parent article.
• A business rule named **knowledge query** that automatically filters the knowledge portal and search results based on the user’s selected language.
• A UI macro named **kb languages**.
• Two fields, named **Language** and **Parent**, in the Knowledge `kb_knowledge` table and the Knowledge form.

### Knowledge form changes

The I18N:Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) adds the following fields to the Knowledge form:

• **Language**: Language in which you are creating the knowledge article. The list is populated based on the languages enabled for the selected knowledge base.
• **Parent**: Number of the article that represents the base language article. This setting keeps translations of the same article related to each other. Consider choosing the same language consistently for the parent article.

**Note**: The Parent field is used for keeping track of translations of articles.

For more information, see [Create a knowledge article](#).

Additionally, the Translated Versions related list is automatically added to the Knowledge form after you save an article.

### Ownership groups

Configure ownership groups and associate them with knowledge articles to maintain article quality, manage approvals, and for timely resolution of feedback.

For the ease of maintenance of knowledge articles, you can assign an ownership group to a knowledge article and shift the ownership of an article from a single person to a group. An ownership group consists of a group of members and a manager who are responsible for knowledge articles. Responsibilities include: approving knowledge articles, performing AQI checks to ensuring article quality, and managing feedback tasks for knowledge articles.

When a knowledge article is assigned to an ownership group:

• Only ownership group members have contribute access to the article even if they don’t have contribute access to the knowledge base of the article. They can edit, approve, publish, and retire the knowledge article with which they are associated.
• Users who aren’t a member of the ownership group member can’t contribute to the article even if they have contribute access to the knowledge base of the article.

When creating or editing a knowledge article, you may need to configure the Knowledge form to add the **Ownership Group** field.

### Activation information

To enable the use of ownership groups, enable the `glide.knowman.ownership_group.enabled` property. This property is available when the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated. By default, the property is disabled.

**Note**: If you use ownership groups, try not to disable the `glide.knowman.ownership_group.enabled` property later. If you must disable the property later,
ensure that you manually reassign all knowledge articles associated with any ownership group, close all article approvals sent to ownership groups, and resolve all open feedback tasks assigned to ownership groups.

Contribute access to articles for authors and revisers

If an ownership group is associated with a knowledge article, the author or reviser of the article can't contribute to the article after the article is published.

Manage ownership groups

Create ownership groups and associate them to knowledge articles. Knowledge group managers or knowledge administrators can edit ownership groups.

The Knowledge Management Advanced plugin (com.snc.knowledge_advanced) must be activated.

Role required: Users with the knowledge_domain_expert or knowledge_admin roles can create ownership groups.

Users with the knowledge_group_manager or knowledge_admin roles can edit ownership groups.

Create an ownership group by adding members and a manager. Knowledge administrators approve ownership groups.

When knowledge articles are created, ownership groups can be associated to them. Ownership groups manage article approvals and feedback and can edit and retire knowledge articles that they are associated with.

Knowledge group managers can edit ownership groups managed by them by adding or removing members without the need for approval. They cannot change the manager assigned in their groups. Only knowledge administrators can reassign managers.

1. Navigate to Knowledge > Ownership Groups > Manage Group.
2. To create an ownership group, select Create Ownership Group from the Request field.

Note: To edit an existing ownership group, select Edit Ownership Group from the Request field.

3. Fill in the fields on the form, as required.

Manage Knowledge Ownership Group form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the ownership group.</td>
</tr>
<tr>
<td>Group email</td>
<td>An email address for the ownership group. Emails are sent to group members in these cases.</td>
</tr>
<tr>
<td></td>
<td>• Activity on articles they are associated with, for example, comments.</td>
</tr>
<tr>
<td></td>
<td>• Article quality checks (AQI) performed on articles they are associated with.</td>
</tr>
<tr>
<td></td>
<td>If no group email is defined, emails are sent to individual group member emails.</td>
</tr>
<tr>
<td>Description</td>
<td>Description that defines the ownership group.</td>
</tr>
<tr>
<td>Manager</td>
<td>Manager for the ownership group.</td>
</tr>
</tbody>
</table>
### Configure the Knowledge Management Service Portal

The Knowledge Management Service Portal enables users to perform the same operations that are available with the Knowledge Management V3 plugin. From the portal, users can view knowledge bases and articles, search for information, sort and filter search results, and provide feedback.

- For new customers on the Madrid and later releases, the Knowledge Management Service Portal plugin (com.snc.knowledge_serviceportal) is active by default.
- For existing customers on release versions prior to Madrid, activate the plugin, if required.
- Configure the Knowledge Management Service Portal properties, including the property that directs users to the Knowledge Management Service Portal homepage.

- Navigate to Service Portal > Portals and click Knowledge Portal. See Service Portal for more information about creating a custom interface.
- System administrators can configure portal pages and configure widgets for searching, sorting, and filtering knowledge base information. To configure widget instance options and configure search, sort, and filter features, see Knowledge Management Service Portal widgets
- To add knowledge bases to the Knowledge Service Portal, complete the following steps.

1. Navigate to Service Portal > Portals and click Knowledge Portal.
2. Click the Knowledge Bases related list.
3. Click Edit to map one or more knowledge bases to the portal.

**Note:** If no knowledge bases are added, all knowledge bases are available in the portal. If knowledge bases are mapped, only those knowledge bases are available in the portal. All search results and all widgets display results from the mapped knowledge bases only.
Section 508 compliance features

Users can view and interact with the Knowledge Management Service Portal article view page using Section 508 compliance features. See Enabling accessibility features for more information.

Enable external or public users to view knowledge articles from the Knowledge Management Service Portal

Enable knowledge articles on the Knowledge Management Service Portal to be visible to external or public users.

The Knowledge Management Service Portal plugin (com.snc.knowledge_serviceportal) must be enabled.

Role required: admin

If you are using Knowledge Management within the Customer Service application, you can automatically make knowledge public by activating and running the Make KM Service Portal Pages Public fix script after you install the Customer Service Management plugin (com.sn_customerservice).

If you are using Knowledge Management as a standalone application, perform the steps in this procedure.

1. Navigate to Service Portal > Pages.
2. Search for kb_home and open it.
3. You have to be in the Global application to edit. If a message appears, click here to edit.
4. Perform one of the following actions.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make knowledge service portal pages visible to public users</td>
<td>a. Select the Public check box.</td>
</tr>
<tr>
<td></td>
<td>b. Click Update.</td>
</tr>
<tr>
<td>Make knowledge service portal pages visible to external users</td>
<td>a. Click the edit user roles icon.</td>
</tr>
<tr>
<td></td>
<td>b. Select snc_external and click Done.</td>
</tr>
<tr>
<td></td>
<td>c. Click Update.</td>
</tr>
</tbody>
</table>

5. Repeat these steps for kb_article_view and kb_search.
6. Perform one of the following actions.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable access to the knowledge base for public users</td>
<td>Ensure that no Can Read user criteria is defined in the knowledge bases you want to give access to.</td>
</tr>
<tr>
<td>Enable access to the knowledge base for external users</td>
<td>Add Can Read access to the knowledge base.</td>
</tr>
</tbody>
</table>

Knowledge Management Service Portal properties

Knowledge Management Service Portal properties determine how information is displayed on the Knowledge portal. You must have the admin role to set configuration properties.

The following system properties are set to direct users to the Knowledge Management Service Portal homepage, and to specify the URL suffix for the homepage.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| `sn_km_portal.glide.knowman.serviceportal.enable_redirect` | Directs users to the desired Knowledge homepage.  
  - Type: true|false  
  - Default value: false  
  Set to true to redirect users navigating to v2 or v3 pages to the Knowledge Management Service Portal homepage. |
| `sn_km_portal.glide.knowman.serviceportal.portal_url` | The URL suffix for the Knowledge Management Service Portal. The default is kb. |

The Knowledge Management Service Portal supports the Knowledge Management V3 properties. Configuring widget instance options on the portal pages can override these properties.

### Knowledge Management Service Portal widgets

The Knowledge Management Service Portal uses a number of widgets to enable searches, display search results, and display articles, related articles, related items, and social Q&A.

The Knowledge Management Service Portal homepage, search results page, and article view page honor the Knowledge Management V3 system properties. If configured, widget instance options can override the system properties.

Users with the knowledge_admin or admin role can configure the widget instance options used on the Knowledge Management Service Portal pages. Use the control + right-click menu to access the widget instance options and configure a widget instance.

**Note:** Before configuring widget instance options, switch to the Knowledge Management - Service Portal scope.

**Homepage widgets:**

- **Knowledge Homepage Search**
  Customize search features for the homepage.
- **Knowledge Bases Browse**
  Displays knowledge base tiles in the homepage.
- **Knowledge Featured Articles**
  Displays a list of featured articles in the homepage.
- **Knowledge Most Useful Articles**
  Displays a list of most useful articles in the homepage.
- **Knowledge Most Viewed Articles**
  Displays a list of most viewed articles in the homepage.
Search results page widgets:

- **Knowledge Breadcrumbs**
  Displays navigation path to the current page.
- **Knowledge Search**
- **Knowledge Facet Header**
  Displays the title for the filter facets.
- **Knowledge Field Facet**
  Display search results filtered by knowledge base, knowledge category, and author.
- **Knowledge Tags Facet**
  Display search results filtered by article tags.
- **Knowledge Resource Facet**
  Display search results filtered by article resource.
- **Knowledge Query Facet**
  Display search results filtered by article rating, number of article views, and last modified.
- **Knowledge Result Sort**
  Displays search results filtered by sort options for returned results.
- **Knowledge Selected Filter**
  Displays the selected facet filters and allows you to clear the selections.
- **Knowledge Result**
  Displays search results filtered by returned results.

Article view page widgets:

- **Knowledge Breadcrumbs**
  Displays navigation path to the current page.
- **Knowledge Article Content**
  Customize what information users can view and what actions they can perform in the article view page.
- **Knowledge Article Helpful**
  Enables users to mark the article as helpful.
- **Knowledge Article Comments**
  Enables users to add comments for the article.
- **Knowledge Attachments**
  Displays article attachments if the **Display Attachment** field for the article is enabled.

**Note:** You must add the Knowledge Attachments widget to any page in addition to Knowledge Article Content widget. After upgrade, if this widget does not get added automatically, you must add it manually.

- **Related Catalog Item**
  Displays a list of catalog items mapped to the article. The widget appears only when the related catalog items are available for the selected article.
- **Knowledge Related Articles**
  Displays a list of related articles with information similar to the selected article. The related articles are manually mapped, automatically predicted, or both. The manually mapped articles appear first in the widget. The widget appears only when the related articles are available for the selected article.
• Affected Products
Displays the products related to the knowledge articles available in the Affected Products related list for the article. The widget appears only when the affected products are available for the selected article.

• Most Recent Tasks
Displays the tasks attached to the articles available in the Attached Tasks related list for that article. The widget appears only when the related tasks are available for the selected article.

• Most Useful
Displays a list of knowledge articles that users found most useful.

Activate the Knowledge Management Service Portal plugin
The Knowledge Management - Service Portal plugin (com.snc.knowledge_serviceportal) is active by default for customers on Madrid and later releases. Existing customers on release versions prior to Madrid can activate the plugin, if required.

Role required: admin

This plugin requires the following plugins:
• Knowledge Management V3 (com.snc.knowledge3)
• Service Portal for Enterprise Service Management (com.glide.service-portal.esm)

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Configure search widget instance options
Configure widget instance options for the search widgets on the Knowledge Management Service Portal homepage and search results page.

Role required: sp_admin or admin

The homepage uses the Knowledge Homepage Search widget and the search results page uses the Knowledge Search widget. Use the widget instance options to customize the search feature for these pages.

1. Navigate to the Knowledge Management Service Portal homepage or search results page.
2. Control + right-click the search bar.
3. Click Instance Options.
4. Configure the desired settings for the search widgets.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title of the search widget. The default for the homepage is Welcome to Knowledge.</td>
</tr>
<tr>
<td>Glyph</td>
<td>An icon that appears in the search bar.</td>
</tr>
<tr>
<td>Instance option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>The color of the search widget. This field appears on the search results page only.</td>
</tr>
<tr>
<td>Bootstrap size</td>
<td>The size of the search widget. This field appears on the search results page only.</td>
</tr>
<tr>
<td>CSS</td>
<td>See widget CSS for details.</td>
</tr>
<tr>
<td>Search Placeholder</td>
<td>Default text that appears in the search bar. This field appears on the homepage only.</td>
</tr>
<tr>
<td>Allow Empty Search</td>
<td>Allow empty knowledge base searches. The default for the homepage uses the system property. The default for the search results page is Yes. For an empty search, the search results page returns all results.</td>
</tr>
<tr>
<td>Allow Instant Search On Keypress</td>
<td>Enables instant search results as you type a search term. The default for the search results page uses the system property. This field appears on the search results page only.</td>
</tr>
<tr>
<td>Minimum Number of Characters for Search</td>
<td>The minimum number of characters required to generate a search.</td>
</tr>
<tr>
<td>Wait time (ms) between searches, if instant search is enabled</td>
<td>The time, in milliseconds, to wait between searches if the instant search feature is enabled. The default wait time is 500 ms. This field appears on the search results page only.</td>
</tr>
<tr>
<td>Alternate URL Parameters for Search</td>
<td>Alternate parameters that appear in the search results URL. By default these parameters include keyword and query. This field appears on the search results page only.</td>
</tr>
<tr>
<td>Alternate URL Parameters for Language</td>
<td>Alternate parameters that appear in the URL denoting the selected language. This field appears on the search results page only.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

*Configure knowledge base tile widget instance options*

Configure widget instance options for the knowledge base tile widgets on the Knowledge Management Service Portal homepage.

Role required: sp_admin or admin

The homepage uses the Knowledge Bases Browse widget to display knowledge base tiles.

1. Navigate to the Knowledge Management Service Portal homepage.
2. Control + right-click a knowledge base tile.
3. Click **Instance Options**.
4. Configure the desired settings for the knowledge base tile widgets.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title that appears above the knowledge base tiles. The default is <strong>Explore our Knowledge Bases</strong>.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>The color of the widget.</td>
</tr>
<tr>
<td>CSS</td>
<td>See <a href="#">widget CSS</a> for details.</td>
</tr>
<tr>
<td>Order By</td>
<td>The order in which the knowledge base tiles appear on the homepage. Use any field on the Knowledge table. If this field is empty, tiles are displayed in alphabetical order. Other available options include article_count.</td>
</tr>
<tr>
<td>Reverse Order</td>
<td>Enable this check box to display knowledge base tiles in the reverse order.</td>
</tr>
<tr>
<td>Post Question Label</td>
<td>The label on the button used to post a question. The default is <strong>Ask a Question</strong>.</td>
</tr>
<tr>
<td>Create Article Label</td>
<td>The label on the button used to create an article. The default is <strong>Create Article</strong>.</td>
</tr>
<tr>
<td>Post Question URL</td>
<td>The parameters that appear in the URL when posting a question.</td>
</tr>
<tr>
<td>Create Article URL</td>
<td>The parameters that appear in the URL when creating an article.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Configure the home page widget instance options**

Configure widget instance options for the widgets used to display popular articles on the Knowledge Management Service Portal homepage.

**Role required:** sp_admin or admin

The homepage displays links to the featured, most viewed, and most useful articles using several widgets. The featured articles are displayed based on the keywords associated with the articles. For information on displaying articles in the Featured content section, see [Pin a knowledge article](#). Most viewed and most useful articles are displayed based on the highest view and use count of the articles.

1. Navigate to the Knowledge Management Service Portal homepage.
2. Control + right-click one of the widgets.
3. Click **Instance Options**.
4. Configure the desired settings for the widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title of the widget.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>The color of the widget.</td>
</tr>
<tr>
<td>Glyph</td>
<td>An icon that appears in the widget.</td>
</tr>
<tr>
<td>CSS</td>
<td>See <a href="#">widget CSS</a> for details.</td>
</tr>
<tr>
<td>Instance option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Table</td>
<td>The table that contains the <strong>Source Field</strong> used to provide the featured, most viewed, and most useful articles widget options. The default table is Knowledge (kb_knowledge).</td>
</tr>
<tr>
<td>Display Field</td>
<td>The title displayed for each article in the list. By default, this is the article short description.</td>
</tr>
<tr>
<td>Secondary Fields</td>
<td>Additional information displayed for each article in the list below the title. By default, this information includes the author, view count, the date that the article was last modified, and the article rating.</td>
</tr>
<tr>
<td>Max number of records to show</td>
<td>The maximum number of articles to include in the list.</td>
</tr>
<tr>
<td>Show even when empty</td>
<td>Enable this check box to display the widget even if there are no articles in the list.</td>
</tr>
<tr>
<td>Show Secondary Fields Label</td>
<td>Enable this check box to display the field labels for the additional information displayed for each article.</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>To restrict the articles that appear in this list to a specific knowledge base, select the knowledge base from the knowledge base list.</td>
</tr>
</tbody>
</table>

5. **Click Save.**

Configure sort widget instance options

Configure widget instance options for the knowledge sort widget on the Knowledge Management Service Portal search results page.

Role required: sp_admin or admin

The search results page uses the Knowledge Result Sort widget to provide sort options for the returned list of results. Use the widget instance options to customize the sort options.

1. Navigate to the Knowledge Management Service Portal search results page.
2. Control + right-click the sort options at the top of the results list.
3. **Click Instance Options.**
4. Configure the desired settings for the sort widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>The color of the search widget.</td>
</tr>
<tr>
<td>CSS</td>
<td>See <a href="#">widget CSS</a> for details.</td>
</tr>
<tr>
<td>Hide Relevancy</td>
<td>Removes the relevancy sort option.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that contains the fields used to sort the list of knowledge items. The default table is <strong>Knowledge</strong>.</td>
</tr>
<tr>
<td>Sort Fields</td>
<td>The fields used for sorting the list of knowledge items.</td>
</tr>
</tbody>
</table>
Configure article list widget instance options

Configure widget instance options for the article lists on the Knowledge Management Service Portal homepage.

Role required: sp_admin or admin

The homepage uses the Article List widget to display different lists of articles, including Featured, Most Useful, and Most Viewed.

1. Navigate to the Knowledge Management Service Portal homepage.
2. Control + right-click one of the article list headers.
3. Click **Instance Options**.
4. Configure the desired settings for the article list widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort Field Labels</td>
<td>The labels for the fields that appear in the sort options. The default is <strong>Views:desc,Newest:desc,Alphabetical</strong>. The sort order for the sort field labels is ascending. To use a descending order, denote :desc.</td>
</tr>
<tr>
<td>Title</td>
<td>The title of the article list.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>The color of the widget.</td>
</tr>
<tr>
<td>Glyph</td>
<td>An icon that appears in the widget.</td>
</tr>
<tr>
<td>CSS</td>
<td>See widget CSS for details.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that stores the list articles.</td>
</tr>
<tr>
<td>Display Field</td>
<td>The title displayed for each article in the list. By default, this is the article short description.</td>
</tr>
<tr>
<td>Secondary Fields</td>
<td>Additional information displayed for each article in the list below the title. By default, this information includes the author, view count, the date that the article was last modified, and the article rating.</td>
</tr>
<tr>
<td>Max number of records to show</td>
<td>The maximum number of articles to include in the list.</td>
</tr>
<tr>
<td>Show even when empty</td>
<td>Enable this check box to display the article list even if it does not contain any articles.</td>
</tr>
<tr>
<td>Show Secondary Fields Label</td>
<td>Enable this check box to display the field labels for the additional information displayed for each article.</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>To restrict the articles that appear in this list to a specific knowledge base, select the knowledge base from the knowledge base list.</td>
</tr>
</tbody>
</table>

5. Click **Save**.
Configure search results list widget instance options
Configure widget instance options for the results list widget on the Knowledge Management Service Portal search results page.

Role required: sp_admin or admin

The search results page uses the Knowledge Result widget to provide display options for the returned list of results. Use the widget instance options to customize the display options.

1. Navigate to the Knowledge Management Service Portal search results page.
2. Control + right-click the list of returned search results.
3. Click **Instance Options**.
4. Configure the desired settings for the results list widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glyph</td>
<td>An icon that appears in the search bar.</td>
</tr>
<tr>
<td>CSS</td>
<td>See widget CSS for details.</td>
</tr>
<tr>
<td>Show Relevancy Score</td>
<td>Shows how relevant each search result is based on the search term. The default setting uses the system property.</td>
</tr>
<tr>
<td>Breadcrumb: Hide Categories</td>
<td>Hides the category in the breadcrumb that appears below the article short description or question in the results list. The default setting uses the system property.</td>
</tr>
<tr>
<td>Breadcrumb: Knowledge Base Separator</td>
<td>The character used as a separator between the knowledge base and the category in the breadcrumb.</td>
</tr>
<tr>
<td>Breadcrumb: Category Separator</td>
<td>The character used as a separator between categories in the breadcrumb.</td>
</tr>
<tr>
<td>Default Sort Order</td>
<td>The default sort order for the list of returned results. The default sort order is <strong>sys_view_count:desc</strong>, which sorts the results by the number of views in descending order.</td>
</tr>
<tr>
<td>How to Display Attachments in Knowledge Search Results</td>
<td>How attachments are shown in the list of returned results. The default uses the system property.</td>
</tr>
<tr>
<td>Label for Show Pinned Articles Link</td>
<td>The text used for the pinned articles link.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that stores the information returned in the search results.</td>
</tr>
<tr>
<td>Knowledge Secondary Fields</td>
<td>Fields that display additional information for each article in the search results.</td>
</tr>
<tr>
<td>Social Secondary Fields</td>
<td>Fields that display additional information for each social Q&amp;A item in the search results.</td>
</tr>
<tr>
<td>Show Secondary Fields Label</td>
<td>Enable this check box to display the field labels for the additional information displayed for each result.</td>
</tr>
<tr>
<td>Instance option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Pagination Type</td>
<td>Controls how additional knowledge article search results are displayed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Standard Pagination</strong>: displays the search results in multiple pages.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Infinite Scroll</strong>: displays the search results while scrolling.</td>
</tr>
<tr>
<td></td>
<td>The default pagination type is set to <strong>Infinite Scroll</strong>.</td>
</tr>
<tr>
<td>Maximum no. of articles displayed per page with standard pagination</td>
<td>The maximum number of items included in a page when the search results list is displayed using standard pagination.</td>
</tr>
<tr>
<td>Maximum no. of articles displayed after first fetch during infinite scroll</td>
<td>The maximum number of items included when the search results list is first displayed using infinite scroll.</td>
</tr>
<tr>
<td>Maximum no. of articles displayed at subsequent fetches during infinite scroll</td>
<td>The maximum number of items included when the search results list updates as the user scrolls to the bottom.</td>
</tr>
<tr>
<td>No. of links in pagination bar</td>
<td>The number of links displayed in the pagination bar.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

*Configure filter facet widget instance options*

Configure widget instance options for the filter facet widgets on the Knowledge Management Service Portal search results page.

**Role required:** sp_admin or admin

The homepage uses several widgets to filter the items in the search results list. There are two types of facet widgets:

• Simple field facets based on the Knowledge table fields
• Advanced query facets based on custom queries of the Knowledge table

Use the widget instance options to customize these facet widgets:

• Knowledge Field Facet (for filtering by knowledge base, knowledge category, and author)
• Knowledge Tags Facet (for filtering by tag)
• Knowledge Resource Facet (for filtering by resource, such as articles and social Q&A)
• Knowledge Query Facet (for filtering by rating, last modified, and number of views)

**Note:** Query facets are displayed when there’s at least one knowledge field facet added to the page.

1. Navigate to the Knowledge Management Service Portal search results page.
2. Control + right-click a filter facet widget.
3. Click **Instance Options**.
4. Configure the desired settings for the selected type of facet widget.
<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glyph</td>
<td>Icon that appears to the left of the title.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the filter facet widgets appear on the left side of the search results page. If empty, the filter facet widgets sort alphabetically.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color of the filter facet widget header.</td>
</tr>
<tr>
<td>CSS</td>
<td>See widget CSS for details.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Table that contains the Source Field used to provide the filter facet widget options. The default table is Knowledge (kb_knowledge).</td>
</tr>
<tr>
<td>Source Field</td>
<td>Field in the Source Table that provides the filter facet widget options. Field types that can be used as a source field include string, choice, glide list, integer, reference, and boolean.</td>
</tr>
<tr>
<td>Facet Identifier</td>
<td>Unique name for the custom query facet that can be used in script code.</td>
</tr>
<tr>
<td>Facet Template</td>
<td>Template that determines the type of facet interaction.</td>
</tr>
<tr>
<td></td>
<td>Knowledge Field Facet widget templates:</td>
</tr>
<tr>
<td></td>
<td>• Single Select: users can select only one filter from this widget.</td>
</tr>
<tr>
<td></td>
<td>• Multi Select: users can select more than one filter from this widget.</td>
</tr>
<tr>
<td></td>
<td>• Dropdown Select: users can select more than one filter from a drop-down menu.</td>
</tr>
<tr>
<td></td>
<td>Knowledge Query Facet widget templates</td>
</tr>
<tr>
<td></td>
<td>• Simple Query: shows a label for each facet value.</td>
</tr>
<tr>
<td></td>
<td>• Rating: shows rating stars.</td>
</tr>
<tr>
<td>Custom Template</td>
<td>Custom template that determines facet interaction and value selection.</td>
</tr>
<tr>
<td>Facet Options</td>
<td>Custom query in JSON format for the label, ID, order, and query for each facet value. Includes the table, value (encoded query), and display value (encoded query).</td>
</tr>
<tr>
<td>Order by</td>
<td>Order of the filter options within the facet widget. The default order is label, which sorts the options in alphabetical order. For reference fields, you can also state an order from the reference field table.</td>
</tr>
<tr>
<td>Minimum results for showing filter search bar</td>
<td>Minimum number of results required to display a search bar at the top of the filter facet widget.</td>
</tr>
<tr>
<td>Minimum results for showing scroll bar</td>
<td>Minimum number of results required to display a scroll bar in the filter facet widget.</td>
</tr>
<tr>
<td>Maximum length for string field</td>
<td>Maximum field length. Only fields whose length is less than this value are allowed to be added as a filter facet.</td>
</tr>
<tr>
<td>Instance option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Alternate URL Parameters</td>
<td>Names of the URL parameters used to initialize this filter facet, if used in the URL as a search parameter.</td>
</tr>
<tr>
<td>Fetch Maximum Values</td>
<td>Option to fetch filter values from all knowledge articles in the search results. Selecting the <strong>Fetch Maximum Values</strong> option might impact the load time for search results. If this option is disabled, the load time improves based on the glide.knowman.search.facet_depth property value. If the glide.knowman.search.apply_acls property is set to true, a filter value can appear in a filter facet even when there are no search results for that filter value. For example, a knowledge base without any articles might appear as a value in the knowledge base filter facet.</td>
</tr>
<tr>
<td>Show Empty Value</td>
<td>If enabled, shows an empty filter facet option that users can select to filter for articles that do not have this field set. For example, if an article does not have an assigned category, clicking the empty option lists all articles with no assigned category.</td>
</tr>
<tr>
<td>Show Only Facet Values Matching Results</td>
<td>Creates a dynamic filter facet widget that displays only those filter values that match the search results rather than showing all values. If you disable this instance option, the time needed to load the filter facet data is reduced.</td>
</tr>
<tr>
<td>Show category hierarchy (valid for kb_category only)</td>
<td>If enabled, shows categories with their hierarchy list up to the fourth-level. When you enable this option, you can select only one category at a time. Any articles that are included in the subcategories beyond the fourth-level also appear in the fourth-level of category. The search results filtered on a selected parent category include articles within that category and all the associated child categories.</td>
</tr>
<tr>
<td>![Note](<a href="https://via.placeholder.com/1520.png?text=Note">https://via.placeholder.com/1520.png?text=Note</a>: If%20the%20number%20of%20knowledge%20articles%20returned%20in%20search%20results%20is%20greater%20than%20the%20search%20facet%20depth%2C%20all%20categories%20are%20displayed%20in%20this%20facet.%20Therefore%2C%20some%20categories%20shown%20in%20this%20facet%20might%20not%20be%20associated%20with%20any%20knowledge%20articles%20in%20the%20search%20results.%20By%20default%2C%20the%20facet%20depth%20is%20set%20to%20300%20and%20configured%20by%20an%20administrator%20in%20the%20glide.knowman.search.facet_depth property.)</td>
<td>Note: If the number of knowledge articles returned in search results is greater than the search facet depth, all categories are displayed in this facet. Therefore, some categories shown in this facet might not be associated with any knowledge articles in the search results. By default, the facet depth is set to 300 and configured by an administrator in the glide.knowman.search.facet_depth property.</td>
</tr>
</tbody>
</table>

5. Click **Save**.
**Configure a user action for the article view page**

Configure a user action for the Knowledge Management Service Portal article view page.

Role required: sp_admin or admin

The article view page uses the Knowledge Article Content widget to provide user actions. Use the widget instance options to customize these actions.

Ensure that the application scope on the Now Platform is set to Knowledge Management Service Portal.

User actions available for the article view page appear in a menu after clicking the overflow icon ( ) in the article header. These actions enable users to flag an article, edit an article, or create an incident for an article.

1. Navigate to the Knowledge Management Service Portal article view page.
2. Control + right-click the article header.
3. Click **Instance Options**.
4. Configure the desired settings for the Knowledge Article Content widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>The color of the widget header.</td>
</tr>
<tr>
<td>CSS</td>
<td>See widget CSS for details.</td>
</tr>
<tr>
<td><strong>Hide All Actions</strong></td>
<td>Hides the user actions in the article header including the <strong>Subscribe/Unsubscribe</strong> button and the overflow icon.</td>
</tr>
<tr>
<td><strong>Show Version Information</strong></td>
<td>Displays version information for the selected article. Requires the Knowledge Management Advanced plugin (com.snc.knowledge_advanced).</td>
</tr>
<tr>
<td><strong>Show Create Incident Action</strong></td>
<td>Displays the <strong>Create Incident</strong> user action when a user clicks the overflow icon in the article header.</td>
</tr>
<tr>
<td><strong>Create Incident Action Label</strong></td>
<td>The label for the user action that appears in the overflow icon menu. The default is <strong>Create Incident</strong>.</td>
</tr>
<tr>
<td><strong>Create Incident Action URL</strong></td>
<td>The target URL for the <strong>Create Incident</strong> user action. If no URL is specified, the system uses the URL in the glide.knowman.create_incident_link system property.</td>
</tr>
<tr>
<td><strong>Redirect to the latest article</strong></td>
<td>Redirects the article view page to the latest accessible version of the article, if available. Disable the <strong>Show Version Information</strong> option to hide the version information on the article view page because any version link will redirect to the latest version only.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Configure article helpful widget instance options**

Configure the Knowledge Article Helpful widget instance options for the Knowledge Management Service Portal article view page.

Role required: sp_admin or admin
The article view page uses the Knowledge Article Helpful widget to allow users to provide feedback on the helpfulness of the article, display a confirmation message after a feedback is provided, and display the percentage of users who found the article to be useful. Use the widget instance options to customize these actions.

1. Navigate to the Knowledge Management Service Portal article view page.
2. Control + right-click Helpful?
3. Click Instance Options.
4. Configure the desired settings for the Knowledge Article Helpful widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>The color of the widget header.</td>
</tr>
<tr>
<td>CSS</td>
<td>See widget CSS for details.</td>
</tr>
<tr>
<td>Show helpful percentage information</td>
<td>Check box to enable the display of percentage of users who found this article to be helpful.</td>
</tr>
<tr>
<td>Helpful Action Label</td>
<td>Label for marking this article as helpful or not.</td>
</tr>
<tr>
<td>Feedback Message</td>
<td>Text that displays when the user marks the article as helpful or not.</td>
</tr>
</tbody>
</table>

5. Click Save.

Configure article comments instance options

Configure the Knowledge Article Comments widget instance options for the Knowledge Management Service Portal article view page.

Role required: sp_admin or admin

The article view page uses the Knowledge Article Comments widget to allow users to rate an article, add a comment, or view existing comments for the article. Use the widget instance options to customize these actions.

1. Navigate to the Knowledge Management Service Portal article view page.
2. Control + right-click the comments section.
3. Click Instance Options.
4. Configure the desired settings for the Knowledge Article Comments widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>The color of the widget header.</td>
</tr>
<tr>
<td>CSS</td>
<td>See widget CSS for details.</td>
</tr>
<tr>
<td>Other Options</td>
<td>Displays the field for users to enter comments. Available options:</td>
</tr>
<tr>
<td></td>
<td>• Yes - displays the field that enables users to enter comments for the article.</td>
</tr>
<tr>
<td></td>
<td>• No - hides the field that enables users to enter comments for the article.</td>
</tr>
<tr>
<td></td>
<td>• Use system property - display or hide the comments field using article view properties.</td>
</tr>
<tr>
<td>Add Comment Label</td>
<td>Label for the field to add comments.</td>
</tr>
</tbody>
</table>
5. **Click Save.**

*Configure related catalog item widget instance options*

Configure the Related Catalog Item widget instance options for the Knowledge Management Service Portal article view page. These options relate to the list of catalog items mapped to an article.

**Role required:** sp_admin or admin

The knowledge article view page displays the Related Items section when an article has related catalog items. Use the widget instance options to customize the Related Items section on the article view page.

1. Navigate to the Knowledge Management Service Portal homepage by adding `/kb` to the end of your instance URL.

   **Note:** Your administrator might have changed this default navigation.

2. Search for and click the article for which you want to modify the instance options for the Related Catalog Item widget.

3. Press Control and right-click the Related Items section.

4. **Click Instance Options.**

5. Configure settings for the Related Catalog Item widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Table</td>
<td>Source table containing related catalog items. The source table specified in the base system is Related Catalog Items (kb_2_sc).</td>
</tr>
<tr>
<td>Source Column</td>
<td>Field in the source table referring to the source record. The source column specified in the base system is Knowledge article (kb_knowledge).</td>
</tr>
<tr>
<td>Title</td>
<td>Title that appears on the widget header. The default title is Related Items.</td>
</tr>
<tr>
<td>Max Number</td>
<td>Maximum number of catalog items to include in the Related Items section on the article view page. The maximum number specified in the base system is 5.</td>
</tr>
<tr>
<td>Use Full Width</td>
<td>Option for displaying the widget in a 12-column grid at 100% of the available width. If you clear the check box, the widget displays at 75% of the available width.</td>
</tr>
<tr>
<td>Target Column</td>
<td>Field in the source table referring to the target record. The target column specified in the base system is Catalog item (sc_cat_item).</td>
</tr>
</tbody>
</table>
### Configure knowledge related articles widget instance options

Configure the Knowledge Related Articles widget instance options for the Knowledge Management Service Portal article view page. These options relate to the list of related articles mapped to an article.

**Role required:** sp_admin or admin

The knowledge article view page displays the Related Articles section when related articles are mapped to an article. Use the widget instance options to customize the Related Articles section on the article view page.

1. Navigate to the Knowledge Management Service Portal homepage by adding `/kb` to the end of the URL for your instance.

   **Note:** You can change the default navigation by configuring the property `sn_km_portal.glide.knowman.serviceportal.portal_url`.

2. Search for and click the article for which you want to modify the instance options for the Knowledge Related Articles widget.

3. Press Control and right-click the Related Articles section.

4. Click **Instance Options**.

5. Configure settings for the Knowledge Related Articles widget.

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Id</td>
<td>URL parameter containing the unique record identifier (sys_id) of the source record. For the article view page, the URL parameter containing the source ID is sys_kb_id.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

### Instance options

<table>
<thead>
<tr>
<th>Instance option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title that appears on the widget header. The default title is Related Articles.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme of the widget header. Select a color for your widget from a list of common bootstrap colors.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon that appears beside each list item displayed in the widget. To skip this field, select the empty glyph.</td>
</tr>
<tr>
<td>CSS</td>
<td>Custom configurations that determine the look and feel of the elements in the widget. For more information, see Service Portal SCSS Primer.</td>
</tr>
<tr>
<td>Use Full Width</td>
<td>Option for displaying the widget in a 12-column grid at 100% of the available width. If you clear the check box, the widget displays at 75% of the available width.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that contains the knowledge articles associated with the Display Fields and Secondary Fields. By default, the table is Knowledge (kb_knowledge).</td>
</tr>
<tr>
<td>Display Field</td>
<td>The title displayed for each article in the related articles list. The display field specified in the base system is the article short description.</td>
</tr>
<tr>
<td>Instance option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Secondary Fields</td>
<td>Additional information displayed for each article in the list below the title. The secondary fields specified in the base system are author, view count, the last modified date of the article, and the article rating.</td>
</tr>
<tr>
<td>Max number of records to show</td>
<td>The maximum number of articles to include in the Related Articles section on the article view page. The maximum number specified in the base system is 5.</td>
</tr>
<tr>
<td>Show even when empty</td>
<td>Option for displaying the widget even if no articles are in the list.</td>
</tr>
<tr>
<td>Show Secondary Fields Label</td>
<td>Options for displaying the field labels for the additional information displayed for each article.</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>To restrict the articles that appear in this list to a specific knowledge base, select the knowledge base from the knowledge base list.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Source table containing related articles. The source table specified in the base system is Knowledge (kb_2_kb).</td>
</tr>
<tr>
<td>Source Column</td>
<td>Field in the source table referring to the source record. The source column specified in the base system is Knowledge article (kb_knowledge).</td>
</tr>
<tr>
<td>Target Column</td>
<td>Field in the source table referring to the target record. The target column specified in the base system is Knowledge article (kb_knowledge).</td>
</tr>
<tr>
<td>Source Id</td>
<td>URL parameter containing the unique record identifier (sys_id) of the source record. For the article view page, the URL parameter containing the source ID is sys_kb_id.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

**Search using the Knowledge Management Service Portal**

Enter one or more words in the search bar on the Knowledge Management Service Portal homepage to view all search results.

Search results include items in which the short description, content, or attached files include the search term. By default, knowledge search results include articles, pinned articles, and social Q&A.

You can also filter the search results.

**Enable multi-language search**

The multi-language search facet is available when more than one supported language is enabled. All available languages are displayed in the facet and you can select which languages you want your search results to appear in. Your selection is maintained per session, but not across logins.
1. To enable different languages, activate the I18N: Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) or activate one of the internationalization plugins for the language you require.

   **Note:** Activating internationalization plugins for any of the available languages automatically activates the I18N: Knowledge Management Internationalization Plugin v2 plugin.

2. Navigate to Knowledge > Administration > Knowledge Search Properties > Enable multilanguage search.
3. Select the Yes check box to enable the feature.

   **Note:** If this property is not enabled, you can only search for one language at a time.

**Search auto-correct feature**

The Knowledge Management Service Portal homepage search tool also includes an auto-correct feature. When enabled, users can auto-correct a typing error in a search term by clicking one of the suggestions. When a search term contains a misspelling, the search tool displays the search results page and includes one or more suggested terms at the top of the page under the heading *Did you mean*. Clicking one of these suggestions shows all the search results that match the selected term.

Users with the system administrator role can enable this feature.

1. Navigate to System Properties > Text Search.
2. Set the following properties to **true**:
   - Suggest alternate search spellings for knowledge or global search (glide.ts.dym.enable_spell_correct).
   - Suggest related searches for knowledge or global search (glide.ts.dym.enable_chain_suggest).
3. Click **Save**.

**Integrating Knowledge Management features with the Service Portal**

To create a consistent user experience for Knowledge Management, integrate Knowledge Management Service Portal in your end-user facing Service Portal.

The Knowledge Management Service Portal includes the following features:

- Multiple knowledge bases
- A Knowledge Management article view page with feedback options
- A Knowledge Management search results page with options to filter and sort search results
- A number of widgets to enable searches, display search results, display knowledge articles, and so on

By default, all knowledge articles in the Service Portal are redirected to the Knowledge Management article view page using the Knowledge Article View page route map. If upgrading from a previous release, a system administrator can activate the Knowledge Article View page route map to take advantage of the features of the Knowledge Management article view page. For more information, see Activate the Knowledge Article View page on upgrade.

System administrators perform the following tasks to integrate the Knowledge Management Service Portal features with the Service Portal:

- Integrate the Knowledge Management homepage with the Service Portal.
Integrate the Knowledge Management search results page with the Service Portal search results page.

Add the Knowledge Management Service Portal widgets to quickly access knowledge articles from the Service Portal homepage (Optional).

**Note:** These configurations apply to the base system pages within the Service Portal only.

**Integrate the Knowledge Management homepage with the Service Portal homepage**

Use a page route map to access the enhanced Knowledge Management homepage from the Service Portal homepage.

The Knowledge Management - Service Portal plugin (com.snc.knowledge_serviceportal) is activated.

**Note:** This plugin is activated by default for customers on Madrid and later releases. Existing customers on release versions prior to Madrid must activate the plugin to perform this configuration task. For more information, see Activate the Knowledge Management Service Portal plugin.

Role required: admin

The Knowledge Management homepage displays knowledge articles and social Q&A items organized by knowledge base and category, featured content, and popular articles. You use a page route map to access the Knowledge Management homepage from the Service Portal homepage.

1. Navigate to **Service Portal > Page Route Maps**.
2. Click **New**.
3. On the Page Route Map form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal(s)</td>
<td>Service Portal</td>
</tr>
<tr>
<td>Route from</td>
<td>kb_view2</td>
</tr>
<tr>
<td>Route to</td>
<td>kb_home</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
</tbody>
</table>

**Note:** On the Page Route Map form, you can fill in the **Short Description** and **Order** fields as appropriate.

4. Click **Submit**.

You can now open the Knowledge Management homepage from the Service Portal homepage by clicking the Knowledge link or Knowledge Base icon link.

**Integrate the Knowledge Management search results page with the Service Portal search results page**

Use a custom knowledge search widget to access the enhanced Knowledge Management search results page from the Service Portal search results page.

Role required: admin

The Knowledge Management search results page in the Knowledge Management Service Portal includes options to filter and sort search results and a number of widgets to enable searches, display search results, display articles, and so on. In this procedure, to access the Knowledge Management search results page...
from the Service Portal search results page, you create a custom knowledge search widget named Search Within and add it to the Service Portal search results page.

1. Create a custom knowledge search widget named Search Within.
   a) Navigate to Service Portal > Service Portal Configuration.
   b) On the Service Portal page, click Widget Editor.
   c) Click Create a new widget.
   d) In the Add a Widget dialog box, in the Widget Name field, enter Search Within. The Widget ID field is automatically populated based on the widget name.
   e) Click Submit.
      The widget HTML template, client script, and server script display in the widget editor.
   f) In the widget editor, enter the following field values to replace any existing text.
      • In the HTML Template field, enter the following code to add a link to the Knowledge Management search results page in the Search Within widget from the Service Portal.

```
<div role="list" class="list-group">
  <span class="list-group-item active">${Search Within}</span>
  <a role="link" class="list-group-item" ng-href="{{data.url}}">${Knowledge}</a>
</div>
```

• In the Server Script field, enter the following code to set the URL parameters for the Knowledge Management search results page:

```
(function(){
  var q = encodeURIComponent($sp.getParameter('q'));
  var kb = $sp.getValue('kb_knowledge_base') || "";
  data.url = '/sp?id=kb_search';
  if(q)
    data.url += "&keyword="+q;
  if(kb)
    data.url += "&kb_knowledge_base="+kb;
})();
```

  Note: For more information about these fields, see Widget developer guide.

   g) Click Save.
2. Add the custom knowledge search widget to the Service Portal search results page.
   a) Navigate to Service Portal > Service Portal Configuration.
   b) Click Designer.
   c) In the Filter by title or Id field, enter sp_search, the ID for the Service Portal search results page, and then select Search.
   d) In the Filter Widget field, search for the Search Within widget and drag it onto the container where you want the widget to appear on the Service Portal search results page.

   Tip: To verify the location and appearance of the newly added Search Within widget on the Service Portal search results page, click the Preview tab.

   The Search Within knowledge search widget is added to the Service Portal search results page. Clicking Knowledge in the widget and searching for a keyword will redirect you to the Knowledge Management search results page in the Knowledge Management Service Portal.

Add widgets to access knowledge articles from the Service Portal homepage
Add the Knowledge Management Service Portal widgets Featured Articles, Most Useful Articles, and Most Rated Articles to the Service Portal homepage to quickly access knowledge articles.

Role required: admin

For more information about Knowledge Management Service Portal widgets, see Knowledge Management Service Portal widgets.

1. Navigate to Service Portal > Service Portal Configuration.
2. Click Designer.
3. Select the Service Portal homepage.
4. In the Filter by title or Id field, enter index, the ID for the Service Portal homepage, and then select Service Portal.
5. In the Filter Widget field, search for the following Knowledge Management Service Portal widgets, and then drag them onto the container where you want them to appear on the Service Portal homepage.

<table>
<thead>
<tr>
<th>Widget Name</th>
<th>Widget Display Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Featured Articles</td>
<td>Featured Articles</td>
</tr>
</tbody>
</table>
### Tip: To verify the location and appearance of the added widgets on the Service Portal, click the **Preview** tab.

Clicking a knowledge article link from one of the added widgets on the Service Portal homepage opens the Knowledge Management article view page in the Knowledge Management Service Portal.

#### Knowledge V3 homepage and Knowledge Management Service Portal comparison

A comparison of the features available on the Knowledge Management V3 homepage and the Knowledge Management Service Portal.

<table>
<thead>
<tr>
<th>Page</th>
<th>Component</th>
<th>V3 Homepage</th>
<th>Knowledge Management Service Portal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home page</td>
<td>Create an article</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Post a question</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Import an article</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Knowledge bases</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Featured content</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Most useful</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Most viewed</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Language selection menu</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Search text box</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Search results page</td>
<td>Create an article</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Post a question</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Import an article</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Search box with language selection</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Sort by</td>
<td>Relevancy</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Last updated (newest)</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Views</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Alphabetical</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>Filter by</td>
<td>Knowledge bases</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Categories</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Authors</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Tags</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>Page</td>
<td>Component</td>
<td>V3 Homepage</td>
<td>Knowledge Management Service Portal</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>-------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Resource</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Rating</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>View count</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>Article meta data</td>
<td>Authored by</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Article number</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Last modified</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Category</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Number of views</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Star rating</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Relevancy rank</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Tags</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Attachments</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Article view page</td>
<td>Back button</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Create Favorite icon</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Navigation hierarchy path</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Article meta data</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>• Article number</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Article version</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Authored by</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Last modified</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Number of views</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Star rating</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Subscribe option</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Flag article option</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Create incident option</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Edit option</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Article language selection option</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Helpful yes/no option</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Star rating</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Text box for comments</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Live feed comment</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Page</td>
<td>Component</td>
<td>V3 Homepage</td>
<td>Knowledge Management Service Portal</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------</td>
<td>-------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td></td>
<td>Copy permalink</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Most Recent Tasks widget</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Affected Products widget</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Most Viewed widget</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Most Useful widget</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>Post a question / Ask a question page</td>
<td>Back button</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Cancel button</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Post Question button</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Search box</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Title</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Text editor</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Knowledge base</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Category</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Tags</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Cancel button</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Social QA view page</td>
<td>Back button</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Navigation path</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Up / down voting</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Subscribe option</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>Showing tags</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Share / edit / delete options</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Text editor for answer</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Ask a Question button</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Question Stats widget</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Recent Questions widget</td>
<td>N</td>
<td>Y</td>
</tr>
</tbody>
</table>
Features not yet supported on Knowledge Management Service Portal

The following features are not yet supported on the Knowledge Management Service Portal:

- Article import on the Search results page
- Hierarchical categories on the Article view page
- Live Feed support for Social Q&A on the Article view page
- Tags added in Social Q&A are not honored in search results

The `glide.knowman.portal.enable_redirect` property is not honored for the following use cases:

- Contextual search in the Incident form
- Connect

Configure knowledge bases for a portal

Select which knowledge bases are displayed in a portal to view the associated knowledge articles. If no knowledge bases are configured, users can view articles from all knowledge bases in the portal.

Role required: admin

1. Navigate to Service Portal > Portals.
2. Select the portal for which you want to enable search for the desired knowledge bases.
3. In the Knowledge Bases related list, click Edit.
4. On the Edit Members form, move the desired knowledge bases from the available items in the Collection column to the Knowledge Bases List column.
5. Click Save.

Configure knowledge subscriptions

Configure knowledge subscriptions by activating the Knowledge Management Advanced plugin and setting the subscription properties.

Ensure that the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated.

Note: The Knowledge Management Advanced plugin activates the Subscriptions and Activity Feed Framework plugin (com.snc.activity_subscriptions).

Role required: knowledge_admin or admin

1. Navigate to Knowledge > Administration > Properties.
2. In the KM Subscription Properties section, configure the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>glide.knowman.enable_km_subscription</code></td>
<td>Enables or disables the Knowledge Management knowledge subscriptions feature.</td>
</tr>
<tr>
<td><code>glide.knowman.enable_km_subscription.roles</code></td>
<td>A comma-separated list of the roles that can use the knowledge subscriptions feature and subscribe to knowledge bases and articles.</td>
</tr>
<tr>
<td><code>glide.knowman.enable_km_subscription.workflow_state</code></td>
<td>A comma-separated list of the article states for which the knowledge subscription feature is available. The default states include Draft, Review, and Published.</td>
</tr>
</tbody>
</table>
3. Click **Save**.

**Knowledge subscription email notification templates**

The knowledge subscription feature uses email notification templates to send subscription notifications to knowledge users.

<table>
<thead>
<tr>
<th>Email template</th>
<th>Subscription type</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM Subscription: Article created</td>
<td>Knowledge base</td>
</tr>
<tr>
<td>KM Subscription: Article revised in KB</td>
<td>Knowledge base</td>
</tr>
<tr>
<td>KM Subscription: Article checked out</td>
<td>Knowledge article</td>
</tr>
<tr>
<td>KM Subscription: Article revised</td>
<td>Knowledge article</td>
</tr>
<tr>
<td>KM Subscription: Article commented</td>
<td>Knowledge article</td>
</tr>
</tbody>
</table>

Users with the admin or knowledge_admin role can customize these email notification templates. To locate the template, navigate to **System Notifications > Email > Notifications**. For more information about customizing a template, see **Create an email notification**.

Subscription notifications include a link at the bottom of the email to the user's Notification Preferences page.

**Out-of-the-box Knowledge Management Performance Analytics Solutions**

Performance Analytics Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

**Performance Analytics Solutions**

Use the widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from for your application with minimal setup.

**Important:** Set up and test Out-of-the-box Solutions on a sub-production instance before enabling them in production.

**Note:**
- Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.
- Out-of-the-box solutions and in-form analytics provide all the configuration records required to analyze default applications. Customize these records for use in your production environment.

To enable the solution for Knowledge Management, an admin can navigate to **Performance Analytics > Guided Setup.** Click **Get Started** then scroll to the section for Knowledge Management. The guided setup takes you through the entire setup and configuration process.
Domain separation and 'Run As' user

By default, System Administrator is the Run As user for data collection jobs in the OOTB Performance Analytics Solutions. Verify that this user exists on the instance, and whether this user has the appropriate level of access. An inappropriate Run As user can cause errors or limit the data that is collected. If you have Domain Separation enabled, ensure you set an appropriate Run As user in each domain.

New and deprecated versions of this solution

In London, this Solution was replaced with a new version, com.snc.pa.knowledge_v2. If you activated an earlier version of the Solution and then upgraded your instance, you still have and can still use the earlier Solution. You can also activate the newer version without losing data from existing indicators and breakdowns. If you activate the newer version, run a historical data collection job to populate any new indicators and breakdowns.

Knowledge Management dashboard

The Knowledge Management dashboard helps knowledge content owners and managers to determine the usage and quality of their knowledge content and ensure the proper processes and procedures are being followed for content creation.
Knowledge Management dashboard - Content Usage tab
Knowledge Management dashboard - Content Governance tab

**Average Time to Publish**

1.00 days
0.00 (0.0%) Jul 16: 1.00 Days

**% Knowledge Articles Published**

96.63%
0.00 (0.0%) Jul 16: 96.63%

**Time to Publish**

- < 1 Day
- 1 day - 1 week
- 1 week - 4 weeks
- 4 weeks or More
Knowledge Management dashboard - Content Quality tab

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Manager: Needs to identify areas of concern and direct resources optimally.</td>
<td>knowledge_manager</td>
<td>Can review the velocity of content publication and see what content customers are searching for, to direct the efforts of content owners more efficiently.</td>
</tr>
<tr>
<td>Knowledge Administrator: Needs clear visibility into the usage and quality of knowledge content.</td>
<td>knowledge_admin</td>
<td>Can plan and direct content creation.</td>
</tr>
<tr>
<td>Content creator: Needs to see the usage of content they own and areas for improvement</td>
<td>pa_viewer</td>
<td>Can see what content in their subject area that customers are looking for.</td>
</tr>
</tbody>
</table>

CSM Knowledge Management dashboard indicators

The CSM Knowledge Management dashboard provides three views, into content usage, content governance, and content quality.

The Knowledge Management dashboard presents the following key performance indicators:

% of Knowledge Articles Published

A daily calculation using the formula: \[
\frac{\text{Number of knowledge articles published}}{\text{Number of knowledge articles active}} \]

% of Knowledge Articles Flagged

A daily calculation using the formula: \[
\frac{\text{Number of knowledge articles flagged}}{\text{Number of knowledge articles active}} \]

Monthly Average Article Rating

A monthly calculation of the sum of all article ratings for the month divided by the number of knowledge articles rated for the month.

Average Click Rank

A monthly calculation using the formula: \[
\frac{\text{Sum of knowledge search ranks}}{\text{Number of knowledge searches with rank}} \]

Click Through Rate

A monthly calculation using the formula: \[
\frac{\text{Number of knowledge searches with rank}}{\text{Number of knowledge searches}} \]

Article Quality Index

A monthly calculation using the formula: \[
\frac{\text{Sum of AQI scores}}{\text{Number of AQI records}} \]

Average Time to Publish

The average time to publish is recalculated daily, as a number of days. The goal of the indicator is for scores to minimize.

Sum of AQI Scores - Monthly
The sum of all Article Quality Index scores created in a month, calculated monthly. The goal is for scores to maximize.

**Number of AQI Records - Monthly**
The number of Article Quality Index records created in a month, calculated monthly. The goal is for the number to maximize.

**Number of Active Users Who Performed Searches - Monthly**
The number of knowledge searches made in a month, calculated monthly. The goal is for the number to maximize.

**Sum of Knowledge Search Ranks - Monthly**
The sum of feedback rankings of knowledge searches made in a month, excluding empty Highest Click Rank values. The goal is for the number to maximize.

**Number of Knowledge Searches with Rank - Monthly**
The number of knowledge searches in a month where the Highest Click Rank has a value higher than zero. The goal is for the number to maximize.

**Number of Knowledge Searches - Monthly**
The number of knowledge searches in a month. The goal is for the number to maximize.

**Number of Knowledge Articles Rated - Monthly**
The number of knowledge feedback records created in a month, excluding records where the Rating field is empty. The goal is for the number to maximize.

**Number of Knowledge Articles Published**
A daily count of the total number of knowledge articles that have entered the Published state. The goal is for the number to maximize.

**Number of Knowledge Articles Flagged**
A daily count of the number of active knowledge articles, with up-to-date workflows, that were flagged. The goal is for the number to maximize.

**Number of Knowledge Articles Active**
A daily count of the number of active knowledge articles with up-to-date workflows. The goal is for the number to maximize.

**Breakdowns**

The following breakdowns apply to the indicators on the dashboard:

- Time to Publish Groups
- Knowledge Base
- Knowledge Category

**Reports**

The dashboards include the following reports:
Integration with external knowledge sources

Use the external content integration feature to integrate content from various external sources and enable unified knowledge search results.

Users store and manage knowledge using various external sources and search each source separately for relevant results. External content integration enables acquiring and searching all WebDAV-compliant source content from a single location. This provides users with a seamless search experience across multiple knowledge sources and drives more usage to the platform.

Using this feature, knowledge administrators can define the external content to be imported into a knowledge base and periodically run a job to import the content. Knowledge users have a seamless user experience searching for relevant content across multiple knowledge sources.

Activate the External Content Integration plugin

The External Content Integration feature is activated with the Knowledge Management - External Content Integration plugin (com.snc.knowledge.external_integration).

Role required: admin

The Knowledge Management - External Content Integration plugin is not active by default.

The following plugins are automatically activated when the Knowledge Management - External Content Integration plugin is activated:

- Centralized Connection and Credentials plugin (com.snc.core.automation.connection_credential)
- Knowledge Management V3 plugin (com.snc.knowledge3)
- Knowledge Management Advanced Installer plugin (com.snc.knowledge_advanced.installer)
The Knowledge > Administration module displays the External Knowledge Sources and External Knowledge Jobs sub-modules when the Knowledge Management - External Content Integration plugin is activated.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Define an external knowledge source

Before you import content, create and configure the connection between the a Web Distributed Authoring and Versioning (WebDAV) - compliant external knowledge source and the ServiceNow knowledge base into which you want to import content. Define import parameters for the external knowledge source.

Define basic authentication credentials and create an HTTP connection to the external source.

Caution: This feature expects that the external source endpoint is a publicly accessible endpoint. Mid-server configuration is not supported.

Role required: admin

Only basic authentication is supported for the external content integration feature.

1. Define the connection from the external source and the target knowledge base.
   a) Navigate to Knowledge > Administration > External Knowledge Sources.
   b) Click New.
   c) Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter unique name for the external source.</td>
</tr>
<tr>
<td>Target Knowledge Base</td>
<td>Select the knowledge base in which you want to create articles for the external content.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Select the connection alias to connect to the external source.</td>
</tr>
</tbody>
</table>

   d) Right-click the form header and click Save.
2. Set import parameters for the external content.
   a) In the Parameter related list, click New.
   b) In the Name field, select the name of the parameter from the drop-down list.
   c) In the Value field, enter the desired value for the parameter.

   The table below lists the parameters and the corresponding values that can be set for the external source.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum size limit (in MB) for this source</td>
<td>Set maximum allowed content size for this source. Once this limit is reached, no further content is processed. Default value is 400 MB.</td>
</tr>
<tr>
<td>Maximum size limit (in KB) per file/content in this source</td>
<td>Set maximum allowed size limit for each file from this external source. If a file exceeds this limit, that file is not processed. Default value is 4000 KB.</td>
</tr>
<tr>
<td>Open search results in the original source system</td>
<td>Set value to true to open search results in the external source system. Set value to false to open search results in the target knowledge base. Default value is set to false.</td>
</tr>
<tr>
<td>Include folders with names that match these regex patterns</td>
<td>Enter a comma-separated list of regular expressions for folder names that need to be included from this external source.</td>
</tr>
<tr>
<td>Exclude folders with names that match these regex patterns</td>
<td>Enter a comma-separated list of regular expressions for folder names that need to be excluded from this external source.</td>
</tr>
<tr>
<td>Create articles when file names match these regex patterns</td>
<td>Enter a comma-separated list of regular expressions for file names that need to be included to create articles.</td>
</tr>
<tr>
<td>Do not create articles when file names match these regex patterns</td>
<td>Enter a comma-separated list of regular expressions for file names that need to be excluded to create articles.</td>
</tr>
<tr>
<td>Maximum retry limit</td>
<td>Maximum number of retries to send request to the external source.</td>
</tr>
</tbody>
</table>

   d) Click Submit.

Import content from an external knowledge source

Run an import job manually or set up a schedule to process the integrated external content.

Role required: admin or knowledge_admin

Each external source is associated with two handlers: the Acquire handler and the Process handler, for running the import job. The acquire handler uses a WebDAV client to acquire external content to create articles. You can customize the process handler to assign categories to articles or populate additional metadata for the knowledge articles.

1. Navigate to Knowledge > Administration > External Knowledge Sources.
2. Select the external knowledge source from which you would like to import content.
3. In the Handler tab, set a schedule to run the acquire and process handlers.
4. In the Related Links section, click Run Scheduled Job.
5. To view all jobs scheduled to run to import content for the external source, click the **Jobs**. You can open the most recent job to monitor the status.

For each file in the external content source, a blank knowledge article is created and the external file is added as an attachment to the article. The short description of the article is derived from the file name of the external content source.

**Note:** If the externally imported content is infected, a notification about each infected file is sent to the users with the knowledge_admin role and Knowledge Base owners. The notified users can then take required actions on the infected files.

### Open knowledge search results in source system

Configure the URL to the external source system to open articles from search results directly in the source system.

Make sure the **Open search results in the original source system** import parameter for the external knowledge source is set to **true**.

You can follow this procedure when you have a file as a knowledge article in Microsoft SharePoint, for example.

**Role required: admin**

1. Navigate to **System Definition > Script Includes**.
2. Open **KBWebDAVContentHandler**.
3. In the **Script** window, override the function **getFileURL** using script shown below.

   ```javascript
   getFileURL: function(fileObj) {
     //write your logic here
   },
   ```

4. Click **Update**.

### Sample configuration for integrating external knowledge content

You can integrate content from multiple external sources so your users can acquire and search knowledge from a single location. Use this sample configuration to create a connection to your external account, configure external knowledge sources, and import content to enable search results for unified content.

### Requirements for integrating external content

Make sure the Knowledge Management -- External Content Integration plugin (com.snc.knowledge.external_integration) is enabled and your external source is WebDAV-compliant.
**Integrate external knowledge sources into the Knowledge Management application**

Create authentication credentials and a connection alias to connect your external knowledge source to the ServiceNow Knowledge Management application. Define import parameters for your external source to import integrated content.

Role required: admin

1. Enable basic authentication on your external account.

   - **Note:** Your external account password is not affected when you enable basic authentication.

2. Create the connection to your external account using the basic authentication credentials.
   a) Navigate to **Connections and Credentials > Credentials**.
   b) Click **New**.
   c) Click **Basic Auth Credentials**.
      Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the credential. For example, Demo_Auth.</td>
</tr>
<tr>
<td>User name</td>
<td>The external account user name created for basic authentication.</td>
</tr>
<tr>
<td>Password</td>
<td>The external account password for the user name.</td>
</tr>
</tbody>
</table>
   
   d) Click **Submit**.

3. Create an HTTP connection to your external account.
   a) Navigate to **Connections & Credentials > Connection & Credential Aliases**.
   b) Select **New**.
   c) In the **Name** field, enter the name of the connection alias.
      For example, Demo_Account.
   d) Right-click the form header and click **Save**.
   e) In the **Connections** related list, click **New**.
      Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the HTTP connection. For example, Demo_Connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credential created to connect to the external account. For example, Demo_Auth.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>WebDAV URL to your external account. This is the WebDAV end point of your external account.</td>
</tr>
</tbody>
</table>

   - **Note:** You can also import contents from a specific folder by appending the folder path to the URL. For example, https://<web link to your external_account>/KnowledgeIT.

   f) Click **Submit**.
4. Configure the external knowledge source for importing content.
   a) Navigate to Knowledge > Administration > External Knowledge Sources.
   b) Click New and fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the external source. For example, Demo_knowledge.</td>
</tr>
<tr>
<td>Target Knowledge Base</td>
<td>Knowledge base in which you want to create articles for the external content. For example, IT.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection alias to connect to the external source. For example, Demo_Account.</td>
</tr>
</tbody>
</table>

   c) Right-click the form header and select Save.
   d) In the Parameter related list, click New.
   e) On the Parameter form, select the name of the import parameter that you want to configure for your external source and then set the value for the parameter.

   The table below lists the parameters and the corresponding values that can be set for the external source.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum size limit (in MB) for this source</td>
<td>Maximum allowable content size to import from your external source. For example, 250 MB.</td>
</tr>
<tr>
<td>Maximum size limit (in KB) per file/content in this source</td>
<td>Maximum allowable size for each article, including attachments, that you can import from this external source. For example, 2000 KB.</td>
</tr>
<tr>
<td>Open search results in the original source system</td>
<td>Opens search results in the external source system if this value is set to true.</td>
</tr>
<tr>
<td>Include folders with names that match these regex patterns</td>
<td>Comma-separated list of regular expressions for folder names to include from this external source. For example, to include all folders names that start with the letters a and b, enter a.<em>,b.</em>.</td>
</tr>
<tr>
<td>Exclude folders with names that match these regex patterns</td>
<td>Comma-separated list of regular expressions for folder names to exclude from this external source. For example, to exclude all folders names that start with the letters a and b, enter a.<em>,b.</em>.</td>
</tr>
<tr>
<td>Create articles when file names match these regex patterns</td>
<td>Comma-separated list of regular expressions for file names that to include when creating articles. For example, to include all file names have .docx and .pdf extensions, enter .<em>/.docx,.</em>\pdf.</td>
</tr>
<tr>
<td>Do not create articles when file names match these regex patterns</td>
<td>Comma-separated list of regular expressions for file names to exclude when creating articles. For example, to exclude file names have .docx and .pdf extensions, enter .<em>/.docx,.</em>\pdf.</td>
</tr>
</tbody>
</table>
Import content from an external knowledge source.

**Use extension points for Knowledge Management**

Use UI extension points to add knowledge article headers and footers to knowledge articles and to customize the email template for notifications when a knowledge article is commented on. Use scripted extension points to customize the feedback object used in the email template for notifications when a knowledge article is commented on.

The Knowledge Management Advanced plugin (com.snc.knowledge_advanced) must be activated to view the KMFeedbackNotification UI extension point and the KMFeedbackObject scripted extension point. These notifications are part of the Subscriptions feature, which is activated with this plugin.

Role required: admin

Using extension points makes it easier to integrate customizations without actually altering the base code. You can extend standard base functionality using customized scripts.

To use UI extension points in Knowledge Management, create an implementation and change the data as required. You can create multiple implementations per extension point, but for these scenarios, the use is limited to one implementation only. Example code is provided in the extension point, which can be edited, as required.

An implementation is delivered in the base system for scripted extension points. You can change the data and add additional fields, as required.

1. To use UI extension points to customize headers and footers in knowledge articles, and the email notification that is sent when a knowledge article is commented on:
   a) Navigate to **System Extension Points > UI Extension Points**.
   b) Click the UI extension point you want to use.

   **Note:**
   - Use the KMArticleViewFooter and KMArticleViewHeader UI extension points to add knowledge article headers and footers to the knowledge article view pages (kb_view.do) in Knowledge Management v3.
   - Use the KMFeedbackNotification UI extension point to customize the email template for notifications when a knowledge article is commented on.

   c) Click **Create Implementation**.
   d) Change the data as required.
   e) Click **Update**.
2. To use scripted extension points to update the feedback object used in the email template for
notifications when a knowledge article is commented on:
   a) Navigate to **System Extension Points > Scripted Extension Points**.

   **Note:** Use the KMFeedbackObject scripted extension point to customize the feedback
   object used in the email template for notifications when a knowledge article is commented
   on.

   b) In the **API Name** column, click `global.KMFeedbackObject`.
   c) In the **Implementations** related list, click the `KMFeedbackObjectBaseImpl` class.
   d) Change the data and add additional fields, as required.
   e) Click **Update**.

**Duplicate knowledge article numbers**

Importing knowledge articles into an instance can create articles with duplicate numbers.

The Knowledge **Number** field is auto-generated and is incremented every time you create an article in an
instance. The initial value for the **Number** field is 10,000. To customize this number:

1. Navigate to **System Definition > Number Maintenance**.
2. In the **Table** column, search for and select **Knowledge**.
3. In the Controls related list, in the **Number** field, enter a new number.
4. Click **Update**.

Importing knowledge articles from another instance or as part of the demo data for another application
may introduce an article with a number that is already in use. Because the Knowledge **Number** field is not
uniquely indexed, the import completes without error.

With duplicate knowledge article numbers present, links to article view pages that use the knowledge
number can behave inconsistently. For example, if there are two articles with the same Knowledge
number KB00000033, the following link may open either of these two articles randomly: `kb_view.do?
sysparm_article=KB00000033`. This can happen in Knowledge search results where clicking on a result
opens a different article instead of the article displayed in the search results.

**Avoiding duplicate Knowledge article numbers**

To avoid inserting Knowledge articles with duplicate numbers into a production environment:

- Do not import demo data articles in production environment.
- Verify the numbers of the articles to be inserted to make sure they are not already in use.
- Create a before insert business rule on the Knowledge table (kb_knowledge) to ensure the new number
  is not already in use.

You can also update the initial value for the Knowledge **Number** field so that newly created articles do not
conflict with existing articles.

1. Navigate to **System Definition > Number Maintenance**.
2. In the **Table** column, search for and select **Knowledge**.
3. In the Controls related list, in the **Number** field, update the count to a number greater than the largest
   value already in the system.
Train the similarity solution for Knowledge Management to find related articles

Train the Knowledge Similar Articles solution definition included within the Predictive Intelligence for Knowledge Management capability to find related knowledge articles when creating or viewing a knowledge article.

Ensure that the Predictive Intelligence plugin (com.glide.platform_ml) and Predictive Intelligence for Knowledge Management plugin (com.snc.knowledge_ml) are activated. For the solution definition to work, the knowledge base must include at least 1000 articles.

Role required: admin

1. Navigate to Predictive Intelligence > Similarity > Solution Definitions.
2. In the ML Solution Definitions list, search for and select the Knowledge Similar Articles solution definition (ml_sn_global_knowledge_similar_articles).
3. On the ML Solution Definition form, verify the default field values for knowledge articles. For more information about the ML Solution Definition form fields, see #unique_1367.

   Note: If the application scope isn't set to Knowledge Management - Machine Learning, you cannot edit the form and a warning message appears. To make the form editable, click the word here at the end of the message.

4. On the ML Solution Definition form, click Update & Retrain.
5. Open the ML Solution Definition form for the Knowledge Similar Articles solution definition (ml_sn_global_knowledge_similar_articles).
6. In the ML Solutions related list, view the training solution progress in the Progress column.

   Note: Alternatively, you can click the link for the solution in the Created column. On the ML Solution Definitions list, click the Show training progress related link.

When the solution is complete, the related knowledge articles appear in the Knowledge results section on the Knowledge form and in the Related Articles section. The Knowledge form appears when you create an article. The Related Articles section appears on the article view page in the Knowledge Management Service Portal and Now Mobile applications.

- To review similarity examples, when Progress is 100%, in the Created column, click the link for the solution. Click the Similarity Examples related link.
- To update the similarity score threshold, type the required value in the Similarity Score Threshold field. Right-click the ML Solution page and click Save.

Knowledge-Centered Service configuration

Knowledge-Centered Service configuration (KCS) is a method for the creation and continuous improvement of knowledge based on the experience of agents and the patterns observed by knowledge reuse.

ServiceNow Knowledge Management is a KCS (V6) verified product. As a KCS (V6) verified product, Knowledge Management provides features to improve knowledge, such as article quality reviews, in-context knowledge capture, and feedback management.
Article quality index for knowledge management

Assess the quality of knowledge articles with the article quality index (AQI). The AQI helps maintain consistent quality of knowledge articles attached to a knowledge base where articles are written by various authors.

Using AQI feature, a knowledge administrator (a user with knowledge_admin role) creates a checklist and adds a set of true or false questions to the checklist to assess the quality of knowledge articles. For each question, the knowledge_administrator assigns a weight based on its importance to the quality measurement and then attaches the checklist to a knowledge base.

A knowledge reviewer (a user with knowledge_coach and knowledge_domain_expert role) performs AQI review on knowledge articles attached to the knowledge base by answering the true or false questions in the checklist. The article quality is then scored based on the cumulative weight of all answers set to true in the checklist.

The average AQI scoring is displayed on the Content Quality tab of the Knowledge Management dashboard (see Knowledge Management dashboard).

Activating article quality index

The article quality index feature is activated with the Knowledge Management Advanced (com.snc.knowledge_advanced) plugin. For details see, Activate the Knowledge Management Advanced plugin.

Create an AQI checklist

Create a checklist of questions that reviewers can use to evaluate the quality of knowledge articles.

Role required: knowledge_admin or admin

1. Navigate to Knowledge > Article Quality Index > AQI checklists, and click New.
2. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checklist</td>
<td>Name for the checklist.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the checklist.</td>
</tr>
</tbody>
</table>

3. Right-click the form header and click Save.
4. In the Checklist Questions related list, add questions to the checklist.
   Add questions and adjust the weight of the questions until the combined weight of all questions is equal to 100. The weight defines the score that is added to the total AQI review score of the article.
when the answer for that question is set to **true**. The maximum score that can be applied to an article in an AQI review is 100.

**Note:** The default AQI pass score is 70. You can change the pass score in the Article Quality Index properties.

To add a question:

a) Click **New**.

b) Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Text for the question to evaluate articles.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description for the question.</td>
</tr>
<tr>
<td>Order</td>
<td>Value for the display order of questions in the checklist.</td>
</tr>
<tr>
<td></td>
<td>The lower the value in the <strong>Order</strong> field, the higher the question displays in the checklist.</td>
</tr>
<tr>
<td>Weight</td>
<td>A value for the question to score the article quality. This value is added to the AQI score when the answer for the question is set to <strong>true</strong>.</td>
</tr>
</tbody>
</table>

**Note:** Before you assign a value for the display order, think about how many questions you would create for the checklist. For example, if you have five questions in a checklist, you can assign the value in increments of 20. This ensures that you have enough values to assign if you add questions to the checklist later.

| Note: | Before you assign a value for the display order, think about how many questions you would create for the checklist. For example, if you have five questions in a checklist, you can assign the value in increments of 20. This ensures that you have enough values to assign if you add questions to the checklist later. |

| Note: | The combined weight of all questions cannot exceed 100. The sum of weights of all questions in a checklist must be equal to 100 to be assigned to a knowledge base. |

<table>
<thead>
<tr>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The combined weight of all questions cannot exceed 100.</td>
</tr>
<tr>
<td>• The sum of weights of all questions in a checklist must be equal to 100 to be assigned to a knowledge base.</td>
</tr>
</tbody>
</table>

c) Click **Submit**.

5. After you finish adding questions to the checklist, click **Update** on the AQI Checklist form.

After you create a checklist, assign it to a knowledge base.
Assign an AQI checklist to a knowledge base

Before a knowledge reviewer can start performing the AQI review, you must assign an AQI checklist to a knowledge base.

You can only assign a checklist to a knowledge base when the weight of all questions in the checklist is equal to 100. Each knowledge base can have one assigned checklist. However, a checklist can be assigned to more than one knowledge base.

Role required: knowledge_admin or admin

1. Navigate to Knowledge > Administration > Knowledge Bases.
2. Click a knowledge base to which you want to assign a checklist.
3. On the Knowledge Base form, click the search icon in the Checklist field and select the AQI checklist to apply.
4. Click Update.

After you assign an AQI checklist to a knowledge base, you can start performing AQI reviews.

Remove an AQI checklist from a knowledge base

Before you can edit a checklist that is assigned to a knowledge base, you must remove it from the knowledge base.

A checklist with pending AQI reviews cannot be removed from the knowledge base until all AQI reviews associated with the checklist are complete.

Role required: knowledge_admin or admin

1. Navigate to Knowledge > Administration > Knowledge Bases.
2. Click a knowledge base from which you want to remove a checklist.
3. On the Knowledge Base form, delete the name of the AQI checklist from the Checklist field.
4. Click Update.

Delete questions from an AQI checklist

Deleting a question in a checklist deletes the text in the question of previously performed AQI reviews that use the checklist. Deleting an AQI question from a checklist will not affect the score of the previously performed AQI reviews. However, the text of the question will not be displayed in the checklist.

You can delete questions from a checklist if the following conditions are met:

- The checklist is not attached to a knowledge base. For more information, see Remove an AQI checklist from a knowledge base.
- There are no AQI reviews using the checklist in progress.

Role required: admin

1. Navigate to Knowledge > Article Quality Index > AQI checklists.
2. Click the AQI checklist from which you want to delete one or more questions.
3. In the Checklist Questions related list, select the check box next to the questions that you want to delete.
4. From the Actions on Selected Rows choice list, select Delete.
5. In the Confirmation window, click Delete.

Perform an AQI review

Perform the AQI review to evaluate the quality of the article.
The knowledge base must have an assigned AQI checklist.

Role required: knowledge_domain_expert, knowledge_coach, knowledge_admin, or admin

Configure the glide.knowman.aqi.article_workflow_states property to set the article workflow states where you could perform AQI reviews. You can perform several AQI reviews for an article. If you perform several AQI reviews for the same version of the article, the latest AQI score appears in the Latest AQI field in the article.

1. Navigate to Knowledge > Articles and click Published.
2. Click an article link.

   **Note:** To read the article and perform the AQI review simultaneously, open the article in two separate tabs or window in your browser. You can then read the article from one tab or window and perform the AQI from another tab or window.

3. Perform the AQI review.

<table>
<thead>
<tr>
<th>Option</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The AQI review is not yet started.</td>
<td>Click Perform AQI in the form header.</td>
</tr>
<tr>
<td>The AQI review was started and is pending.</td>
<td>Click Continue AQI in the form header.</td>
</tr>
</tbody>
</table>
4. In the Article Checklist Answers related list, read the questions and evaluate which ones are true. Double-click the Answer cell for each question that is true, select true, and click the green check mark.

**Note:** The associated Weighted Score is applied to the AQI score when the answer is set to true.
5. Perform one of the following actions:

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit the completed AQI review.</td>
<td>Click Submit. The form refreshes and the total score of the AQI review is displayed in the AQI score field. The system sends an email notification as follows: • If the AQI review was performed on the first version of the article, the system sends an email notification to the author of the article. • If the AQI review was performed on subsequent versions of the article, the system sends an email notification to the author and creator of the article versions. Note: The notification includes the AQI review score and AQI review result. You can customize the content and design of the notification emails.</td>
</tr>
<tr>
<td>Save the pending review to complete later.</td>
<td>Click Update and return to the Article Checklist Summaries list. The checklist with pending reviews is added to the My Pending AQI Checklists queue. When you want to complete the AQI reviews, navigate to Knowledge &gt; My Pending AQI Checklists and complete the reviews.</td>
</tr>
</tbody>
</table>

To view all the AQI reviews you completed, navigate to Knowledge > My Completed AQI Checklists.

View all pending and completed AQI reviews

View checklists of all users to monitor the pending and completed reviews.

Role required: knowledge_admin or admin

1. Navigate to Knowledge > Article Quality Index
2. Do one of the following:
   • To view all completed AQI checklists, select All Completed AQI Checklists.
   • To view all pending AQI checklists, select All Pending AQI Checklists.

Delete AQI reviews

Delete an AQI review that was created by mistake or is no longer required.

Roles required:
• To delete an AQI in a submitted state: admin or knowledge admin
• To delete an AQI not in a submitted state: knowledge admin or the reviewer who initiated the AQI

1. Navigate to Knowledge > Articles > My Pending AQI Checklists.
2. Select all checklist reviews you would like to delete.
3. Click Delete.
Automating feedback management to improve content

Manage high volumes of article feedback by enabling task generation for negative feedback. When an article is rated poorly or marked as unhelpful, a feedback task is generated.

If an ownership group is assigned to the article, the feedback task is assigned to the manager of the ownership group. Ownership group managers can reassign tasks to another group member, or group members can assign a feedback task to themselves.

If no ownership group is assigned to the article, the feedback task is assigned to the author or reviser of the article.

The task assignee can update the article, create a new article, request additional feedback, or reassign the task and receives notification after the feedback is updated or resolved.

**Note:** The actionable feedback feature is available in the Knowledge Management Service Portal. To use the actionable feedback feature in other service portals, you can activate the Knowledge Article View page route map. Beginning with New York, the Knowledge Article View page route map is activated by default. Existing customers on release versions prior to New York can activate the Knowledge Article View page route map. For more information, see Activate the Knowledge Article View page on upgrade.

Enable actionable knowledge feedback

The actionable knowledge feedback feature is available when the Knowledge Management Service Portal (com.snc.knowledge_serviceportal) plugin is activated and the actionable knowledge feedback properties are enabled.

Role required: admin

The actionable feedback feature is available in the Knowledge Management Service Portal. To use the actionable feedback feature in other service portals, you can activate the Knowledge Article View page route map. For new customers, the Knowledge Article View page route map is activated by default.

By default, negative article feedback does not automate the triggering of feedback tasks. You must configure these properties to generate feedback tasks when an article is marked as not helpful or rated below a set value.

1. Navigate to Knowledge > Administration > Properties.
2. In the Actionable Feedback Properties section, configure the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create actionable feedback task when an article is marked as not helpful.</td>
<td>Select <strong>Yes</strong>.</td>
</tr>
<tr>
<td>Create actionable feedback task when an article is rated at or lower than this value. 0 or no value indicates that actionable feedback tasks are not enabled for Rating type feedback.</td>
<td>Enter a value from 1 to 5 to specify the rating threshold for generating a feedback task. For example, if you set this value to 3, a feedback task is generated when a user selects three or less stars to rate an article.</td>
</tr>
</tbody>
</table>

**Note:** If you enter '0', a negative article feedback does not generate a feedback task.

3. **Click Save.**
Work on a feedback task

You can change the state of a task and resolve or reassign tasks generated by article feedback.

Role required: none

- If no ownership group is assigned to the article, the feedback task is available to you as the author or reviser of the article.
- If an ownership group is assigned to the article, a feedback task is assigned to you as an ownership group manager. As a manager, you can reassign the task to another group member. All group members see the feedback task in All Open Tasks. As a group member, you can reassign the task to yourself to appear in My Assigned Tasks.

1. Navigate to Knowledge > Feedback Management > My Assigned Tasks.
2. Select a feedback task.
3. Review the feedback given by the submitter.

When a feedback task is generated, the information in the article feedback form is copied to the feedback task form as follows:

<table>
<thead>
<tr>
<th>Feedback task form field</th>
<th>Information from article feedback form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason</td>
<td>The selected reason for the feedback.</td>
</tr>
<tr>
<td>Description</td>
<td>Text in the Details field.</td>
</tr>
</tbody>
</table>

- **Note:** If feedback is negative and the Details field is left blank, this field indicates whether the article was not helpful or rated poorly.

4. To work on the feedback task:

<table>
<thead>
<tr>
<th>Change the feedback task state to</th>
<th>If you want to</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Work in progress</strong></td>
<td>Start working on the feedback task.</td>
</tr>
<tr>
<td></td>
<td>You can save the feedback task and edit the article or create a new article if the information in the existing article is irrelevant or obsolete.</td>
</tr>
<tr>
<td><strong>Awaiting information</strong></td>
<td>Request clarification from the feedback submitter.</td>
</tr>
<tr>
<td></td>
<td>In the Additional Comments field, enter information you need from the submitter and click Update. This triggers an email notification for the feedback task submitter.</td>
</tr>
<tr>
<td><strong>Resolved</strong></td>
<td>Resolve the feedback task.</td>
</tr>
<tr>
<td></td>
<td>In the Resolution Code field, select the code for resolving the article. In the Resolution notes field, enter the reason for the resolution and click Update. An email notification is sent to the feedback submitter. The email notification includes the portal URL for the article from where the feedback submitter can accept or reject the feedback.</td>
</tr>
<tr>
<td>Change the feedback task state to</td>
<td>If you want to</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Closed</td>
<td>Close the feedback task without the submitter having to accept the feedback resolution.</td>
</tr>
</tbody>
</table>

**Note:** If the submitter accepts the feedback resolution, the state for the feedback task is automatically set to **Closed**. You can view all closed feedback tasks in your queue by navigating to Knowledge > Feedback Management > My Closed Tasks.

---

**Track the progress on a feedback task**

Monitor open and closed feedback tasks and track the duration of time a feedback task remains in each state.

**Role required:** Owner of the knowledge base, knowledge_manager, knowledge_admin, or admin

1. **Navigate to the open or closed tasks you want to track.**

<table>
<thead>
<tr>
<th>To</th>
<th>Navigate to</th>
</tr>
</thead>
<tbody>
<tr>
<td>View open feedback tasks</td>
<td>Knowledge &gt; Feedback Management &gt; All Open Tasks and select a feedback task.</td>
</tr>
<tr>
<td>View closed feedback tasks</td>
<td>Knowledge &gt; Feedback Management &gt; All Closed Tasks and select a feedback task.</td>
</tr>
</tbody>
</table>

2. **In the Knowledge Feedback Task Metrics related list section, select a feedback task metric to view the start and end time and the duration of the feedback task.**

**Note:** If you are a knowledge administrator, you can view the feedback tasks and task metrics of articles in the knowledge bases. If you are a knowledge owner or knowledge manager, you can view feedback tasks and task metrics of all articles in the knowledge bases you own or manage.

**Enable creating an article from a customer service case**

You can enable authors to reuse information in a case by copying case details into an article template. Use the pre-defined customer service source case table to article template target table configuration or create custom configurations between the two tables to copy information from a case to an article.

- The Knowledge Management Advanced plugin must be active.
- The KCS for Customer Services Management property must be enabled
- The pre-defined KCS article template or a newly created article template must be active.

**Note:** You can do one of the following to create an article from a case:

- Use the pre-defined Case KCS Article mapping as is or modify the field mappings between the case source table and article template target table.
- Create a new article template target table and map it to the case source table and customize the field mappings between them. For information on creating article templates, refer to Create an article template.
- Knowledge users use the Create Knowledge button in a case form to create an article from a case and must have “can contribute” permission for at least one active knowledge base to create an article from a case. For information on user permissions, see Knowledge Management roles.
Role required: sn_customerservice.customer_admin or admin

The pre-defined **Case KCS Article** mapping is stored in the CSM Table Map [csm_table_map] table. This configuration has the sn_customerservice_case source case table configured to the kb_template_kcs_article target article template table with the four field mappings pre-configured between the tables. You can customize the existing field mappings or map additional fields between the tables.

1. In the application filter navigator, type `csm_table_map.list`.
2. Click **Case KCS Article**.
3. From the **Target Table** list, use the pre-defined KCS article template table or select the newly created article template table.
4. Map each customer service case field that must be used to create knowledge articles.
   a) In the **Basic Field Mapping** related list, click **New**.
      To map fields, fill in the following fields:

      **Customer service case table to article template target table field mapping**

      | Field   | Instructions |
      |---------|-------------|
      | Source Field | Select the field in the source case table that contains the information to be copied to the field in the article template target table. |
      | Target Field | Select the field in the article template target table to which you need information copied to from the field in the source case table. |

   b) Click **Submit**.
   c) To map fields using advanced scripts, select the **Advanced Field Mapping** check box and then map the fields between the source and the target table using advanced scripts in the **Advanced Field Mapping** tab.

   **Note:**
   If the same source or target field is configured in both the basic and advanced field mappings, the advanced field mapping overrides the basic field mapping.

   If the fields configured in the basic and advanced field mapping are different, the field configurations in the advanced field mapping are appended to the field configurations in the basic field mapping.

d) To customize when and how the **Create Knowledge** button is displayed, use the condition builder in the **Condition** tab or select **Use Advanced Condition** check box and configure using advanced scripts.

   **Note:** If you change the target table in the **Case KCS Article** mapping, also update the scripts with the configuration changes for display of this button.

5. Click **Update**.

**Enable creating a knowledge article from an incident**

Enable users to quickly and easily reuse information from an incident in a knowledge article.

Role required: admin
Perform the following steps to enable creating a knowledge article from an incident. You can also create a knowledge article from an incident using an article template. For more information, see Create a knowledge article from an incident using an article template.

**Note:** Once you have performed the configuration steps, knowledge users can select the Knowledge check box on the Incident form to create an article from an incident. They must have Can Contribute access to at least one active knowledge base to create an article.

Create field mapping from an incident to a knowledge article

Copy information from an incident into a knowledge article by creating custom mapping between the Incident table and the KCS article table.

Role required: admin

- Ensure that the Knowledge Advanced plugin (com.snc.knowledge_advanced) is active.
- Ensure that the KCS Article template is active.

1. Navigate to **Knowledge > Administration > Article Templates**.
2. Set the **Active** field to **true** for the KCS Article template.

1. In the filter navigator, type `csm_table_map.list`.
2. Click **New**.
3. In the **Mapping Name** field, enter **Incident KCS Article**.
4. In the **Source Table** field, enter **Incident**.
5. In the **Target Table** field, enter **KCS Article**.
6. Right-click the form header and **Save**.
7. In the **Basic Field Mapping** related list, click **New**.
8. Create mappings for the following fields.

<table>
<thead>
<tr>
<th>Source Field</th>
<th>Target Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sys ID</td>
<td>Source Task</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Resolution notes</td>
<td>Resolution</td>
</tr>
</tbody>
</table>

**Note:** You can create field mappings for more fields, as required.

- In the **Source** field, select the field in the source Incident table that contains the information to be copied to the field in the article template target table.
- In the **Target** field, select the field in the article template target table to which you need information copied to from the field in the source Incident table.

9. To customize when and how the Knowledge check box is displayed, click the **Condition** tab.
10. To map fields using advanced scripts, select the **Advanced Field Mapping** check box.
11. On the **Advanced field Mapping** tab, paste in the following code.

```javascript
(function (source,target) {
    // Get the first comments from incident and use it as Issue description for article
    var notes = source.comments.getJournalEntry(-1);
    var entries = notes.split("\n\n");
    var comment = ";
```
The first comment on an incident is mapped to the **Issue Description** field in the knowledge article.

**Note:** If the same source or target field is configured in both the basic and advanced field mappings, the advanced field mapping overrides the basic field mapping.

If the fields configured in the basic and advanced field mapping are different, the field configurations in the advanced field mapping are appended to the field configurations in the basic field mapping.

### Add a property to enable creating knowledge article from incidents

Add a property, which is required to allow users to create a knowledge article from an incident.

Role required: admin

1. In the Filter navigator, enter `sys_properties.list`.
2. Click **New**.
3. Fill in the following fields.

   **System Property form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>enable_kcs_incident</td>
</tr>
<tr>
<td>Description</td>
<td>Enable Knowledge Centered Services (KCS) for Incident Management.</td>
</tr>
<tr>
<td>Type</td>
<td>true</td>
</tr>
<tr>
<td>Value</td>
<td>true</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

### Create a UI action to enable creating knowledge articles from incidents

Create a UI action to add the Knowledge check box to the Incident form.

Role required: admin

1. Navigate to **System UI > UI Actions**.
2. Click **New**.
3. Fill in the following fields.

   **UI Action form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Create Knowledge</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Table | Incident
Action name | create_knowledge

4. Select the **Client** check box.
5. Select the **List v3 Compatible** check box.
6. Select the **Form button** check box.
7. In the **Onclick** field, enter `createKnowledgeClient()`.
8. In the **Condition** field, enter `gs.getProperty("enable_kcs_incident") == 'true' && new global.CSMTTableMapUtil (current).findMapByName("incident_kcs_article") && new global.KBKnowledge().canCreate()`.
9. In the **Script** field, enter the following code.

```javascript
function createKnowledgeClient() {
  if (g_form.modified) {
    alert(new GwtMessage().getMessage('You have unsaved changes. Please save them to continue.'));
  }else{
    //Call the UI Action again but skip the 'onclick' function
    gsftSubmit(null, g_form.getFormElement(), 'create_knowledge');
    //MUST call the 'Action name' set in this UI Action
  }
}

//Code that runs without 'onclick'
//Ensure call to server-side function with no browser errors
if (typeof window == 'undefined')
  CreateKnowledgeServer();

function CreateKnowledgeServer() {
  current.update();

  var map = new global.CSMTTableMapUtil (current);
  map.findMapByName("incident_kcs_article");
  var targetURL = map.getTargetURL();
  var referenceLink = "&sysparm_collection=incident&sysparm_collectionID="+current.sys_id + "&sysparm_collection_key=task&sysparm_link_collection=m2m_kb_task&sysparm_collection_related_field=kb_knowledge&sysparm_referring_url=incident.do%3fsys_id%3d"+current.sys_id;
  if (targetURL)
    action.setRedirectURL(targetURL[0]+referenceLink);
}
```

### Enable creating a knowledge article from an HR case

Enable users to quickly and easily reuse information from an HR case in a knowledge article.

**Role required:** admin

- Ensure that the Human Resources Scoped App: Core (com.sn_hr_core) plugin is active.
- Ensure that the Developer Application is set to **Human Resources: Core**.

**Note:** To check, navigate to the Settings icon and then Developer > Application.

Perform the following steps to enable creating a knowledge article from an HR case.
Create field mapping from an HR case to a knowledge article

Copy information from an HR case into a knowledge article by creating custom mapping between the HR case table and the KCS article table.

Role required: admin
- Ensure that the Knowledge Advanced plugin (com.snc.knowledge_advanced) is active.
- Ensure that the Developer Application is set to Human Resources: Core.
- Ensure that the KCS Article template is active.

1. Navigate to Knowledge > Administration > Article Templates.
2. Set the Active field to true for the KCS Article template.

1. In the filter navigator, type csm_table_map.list.
2. Click New.
3. In the Mapping Name field, enter HR Case KCS Article.
4. In the Source Table field, enter HR Case.
5. In the Target Table field, enter KCS Article.
6. Right-click the form header and Save.
7. In the Basic Field Mapping related list, click New.
8. Create mappings for the following fields.

<table>
<thead>
<tr>
<th>Source Field</th>
<th>Target Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sys ID</td>
<td>Source Task</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Close notes</td>
<td>Resolution</td>
</tr>
<tr>
<td>Description</td>
<td>Cause</td>
</tr>
</tbody>
</table>

9. To customize when and how the Knowledge check box is displayed, click the Condition tab.
10. To map fields using advanced scripts, select the Advanced Field Mapping check box.
11. On the Advanced field Mapping tab, paste in the following code.

```javascript
(function (source) {
  // Get the first comments from HR case and use it as Issue description for article
  target.short_description=source.short_description+"";
  target.kb_resolution=source.close_notes+"";
  target.kb_cause=source.description+"";
  var notes = source.comments.getJournalEntry(-1);
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
var entries = notes.split("\n\n");
var comment = "";
if(entries[entries.length-2]){
  comment = entries[entries.length-2];
  var part = comment.toString().indexOf("\")
  if(part != -1){
    comment = comment.toString().substring(part+2).replaceAll("\r\n","<br/>
    )
  }
  if(comment)
    target.kb_issue = comment;

  //Only if selected article type is active
  var tem = new GlideRecord("kb_article_template");
  tem.addQuery("child_table","kb_template_kcs_article");
  tem.addActiveQuery();
  tem.query();
  if(!tem.hasNext())
    return false;

  //Do not allow to create the knowledge again
  var now_GR = new GlideRecord("kb_knowledge");
  now_GR.addQuery("source",source.sys_id);
  now_GR.query();
  if(now_GR.next())
    return false;

  return true;
}
}(source);

The first comment on an HR case is mapped to the **Issue Description** field in the knowledge article.

**Note:** If the same source or target field is configured in both the basic and advanced field mappings, the advanced field mapping overrides the basic field mapping.

If the fields configured in the basic and advanced field mapping are different, the field configurations in the advanced field mapping are appended to the field configurations in the basic field mapping.

Add a property to enable creating knowledge articles from HR cases

Add a property, which is required to allow users to create a knowledge article from an HR case.

Role required: admin

Ensure that the Developer Application is set to **Human Resources: Core**.

1. In the Filter navigator, enter `sys_properties.list`.
2. Click **New**.
3. Fill in the following fields.

   **System Property form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>enable_kcs_hr</td>
</tr>
<tr>
<td>Description</td>
<td>Enable Knowledge Centered Services (KCS) for HR Service Delivery.</td>
</tr>
<tr>
<td>Type</td>
<td>true</td>
</tr>
</tbody>
</table>
Create a UI action to enable creating knowledge articles from HR cases

Create a UI action to add the Knowledge check box to the HR case form.

Role required: admin

Ensure that the Developer Application is set to Human Resources: Core.

1. Navigate to System UI > UI Actions.
2. Click New.
3. Fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Create Knowledge</td>
</tr>
<tr>
<td>Table</td>
<td>HR Case</td>
</tr>
<tr>
<td>Action name</td>
<td>create_knowledge</td>
</tr>
</tbody>
</table>

4. Select the Client check box.
5. Select the List v3 Compatible check box.
6. Select the Form button check box.
7. In the Onclick field, enter createKnowledgeClient().
8. In the Condition field, enter gs.getProperty("sn_hr_core.enable_kcs_hr") == 'true' && new global.CSMTableMapUtil (current).findMapByName("sn_hr_core.hr_case_kcs_article") && new global.KBKnowledge().canCreate().
9. In the Script field, enter the following code.

```javascript
function createKnowledgeClient() {
    if (g_form.modified) {
        alert(new GwtMessage().getMessage('You have unsaved changes. Please save them to continue.'));
    }else{
        //Call the UI Action again but skip the 'onclick' function
        gsftSubmit(null, g_form.getFormElement(), 'create_knowledge');
        //MUST call the 'Action name' set in this UI Action
    }
}

//Code that runs without 'onclick'
//Ensure call to server-side function with no browser errors
if (typeof window == 'undefined')
    CreateKnowledgeServer();

function CreateKnowledgeServer(){
    current.update();

    var map = new global.CSMTableMapUtil (current);
    map.findMapByName("sn_hr_core.hr_case_kcs_article");
    var targetURL = map.getTargetURL();
    var referenceLink =
```
Use Knowledge Management

Share your ideas and experience by creating a knowledge article. Search and find information such as self-help, troubleshooting, and task resolution in knowledge bases. Review, provide feedback on knowledge articles, and resolve issues yourselves rather than contacting customer service or an internal helpdesk.

Role required: none

Use Knowledge Management in one or more of the following ways.

Knowledge Management guide for users

After knowledge bases are set up, you can start searching and creating articles. If Social Q&A was activated for the knowledge base, you can also submit answers or answer questions for other users.

Requirements

Role required

All users can read knowledge articles. Users with the knowledge or any other fulfiller role, such as sn_customerservice_agent, can create and edit knowledge articles in a knowledge base, unless the knowledge manager has restricted access to the knowledge base or knowledge articles.

If you need these permissions, contact the knowledge manager or knowledge administrator for the knowledge base.

What to do

Create knowledge articles

If you have the required permissions for a knowledge base, you can create articles for it. You can create articles from the Self-Service application menu or by importing Word documents.

You can also create knowledge articles from incidents and problems.

Search for knowledge articles

From the Knowledge homepage, you can select a knowledge base to search for articles and answers. You can view only the knowledge bases to which you have access.

Access to knowledge using your mobile device is supported.

Ask and answer questions

If Social Q&A was activated for a knowledge base, you can ask and answer questions. You can also browse and vote on answers.
Next steps

After articles are created, you can perform the following tasks to make sure that articles are organized in the right knowledge bases and retired when appropriate. If existing knowledge bases do not fit your needs, you can request a new knowledge base.

- Move a knowledge article
- Retire a knowledge article
- Request a knowledge base

Knowledge Management Service Portal homepage features

The Knowledge Management Service Portal homepage displays knowledge articles and social Q&A items organized by knowledge base and category, as well as featured content and popular articles. Learn how to navigate the homepage to search for and find useful and relevant information quickly.

To use the Knowledge Management Service Portal, the Knowledge Management — Service Portal plugin (com.snc.knowledge_serviceportal) must be activated.

**Note:** It is active by default for customers on the Madrid and later releases. Existing or upgrade customers must activate the plugin and enable the glide.knowman.serviceportal.enable_redirect property.

Your organization can customize the homepage, so it may look different to the following image. You must be logged in to view the knowledge homepage.

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge profile menu</td>
<td>Click your profile photo to either view your knowledge profile or logout.</td>
</tr>
<tr>
<td>Search</td>
<td>Enter a search term to search knowledge bases and social Q&amp;A.</td>
</tr>
<tr>
<td>Counters</td>
<td>Displays the number of available knowledge bases and the total number of knowledge articles and social Q&amp;A items.</td>
</tr>
<tr>
<td>Ask a question</td>
<td>This action is available to logged in users with the knowledge role. Click Ask a Question, which opens a question page. Fill in the Question and Question details fields, and click Post question to post the question.</td>
</tr>
<tr>
<td>Overflow icon (***</td>
<td>Click the Overflow icon and select Create Article to create a knowledge article.</td>
</tr>
<tr>
<td>Browse knowledge bases</td>
<td>Click a knowledge base to view knowledge articles and questions stored in it. View counters of how many articles and questions are stored in the knowledge base. Click Show All to view up to eight available knowledge bases.</td>
</tr>
<tr>
<td>UI component</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Subscribe</td>
<td>Click <strong>Subscribe</strong> to subscribe to that knowledge base. Unsubscribe by clicking <strong>Unsubscribe</strong>.</td>
</tr>
<tr>
<td>Featured</td>
<td>Lists any knowledge articles that were pinned. For more information, see <a href="#">Add a knowledge article to featured content</a>.</td>
</tr>
<tr>
<td>Most Useful</td>
<td>Lists the top five articles that were marked as helpful.</td>
</tr>
<tr>
<td>Most Viewed</td>
<td>Lists the top five articles with the most views.</td>
</tr>
</tbody>
</table>

**Note:** The Knowledge Management Service Portal homepage is mobile responsive.

**Knowledge Management Service Portal search results page features**

View a list of search results as well as options for sorting and filtering the items in the list. You can also use knowledge search in other Service Portals.

**Note:** When you perform a new search, the filters you selected earlier on the Knowledge Management search results page are not saved. You must reselect the filters that you want to apply for every search.

**Knowledge Management search results page**

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search bar</td>
<td>Use the search bar at the top of the page to search for additional information.</td>
</tr>
<tr>
<td>Sort</td>
<td>Sort the items in a knowledge base or search results list using the <strong>Sort by</strong> options at the top of the list.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Views:</strong> sorts by number of article views.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Newest:</strong> sorts by the date created or updated.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Alphabetical:</strong> sorts alphabetically by the article <strong>Short description</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Relevancy:</strong> sorts by relevance to the search term.</td>
</tr>
<tr>
<td></td>
<td>The header displays the number of search results, which updates as the user selects and de-selects filters.</td>
</tr>
<tr>
<td></td>
<td>When you navigate away from the search results page and then return, your last sort selection is retained.</td>
</tr>
<tr>
<td>UI component</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Search results list</td>
<td>View knowledge articles, pinned articles, and social Q&amp;A items. Knowledge article search results include articles in which the short description, text content, or attached file content includes the search term. For social Q&amp;A items, search results include answered and unanswered questions, and questions with accepted answers. View the knowledge article short description or question, the knowledge base in which the article or question is stored, author name, number of views, and rating information.</td>
</tr>
<tr>
<td>Language filter facet widget</td>
<td>Language: lists the languages that have been activated. Select one or more languages to display search results in. Your selection is maintained across logins. If multi-language search is enabled, you can search for multiple languages simultaneously.</td>
</tr>
<tr>
<td>Knowledge base filter facet widget</td>
<td>Knowledge Base: lists the available knowledge bases</td>
</tr>
<tr>
<td>Category filter facet widget</td>
<td>Category: lists the available knowledge categories. <strong>Note:</strong> Shows a hierarchy of categories if the administrator configured the <em>Show category hierarchy (valid for kb_category only)</em> instance option for the facet widget.</td>
</tr>
</tbody>
</table>

Note: Shows a hierarchy of categories if the administrator configured the *Show category hierarchy (valid for kb_category only)* instance option for the facet widget.
### UI component

| Other filter facet widgets | Use filter facets to refine your search results.
The selections you make filter the items displayed in the search results list. The search results list updates to display only those items that match your selections. Deleting a selection from the filter facet or breadcrumb reverses the filtering in the list.

Clear selected filter options by:
  - Deleting a single option from the search results list header.
  - Clicking **Clear all** in the search results list header.
  - Clicking **Clear** in the filter facet widget header.
  - Author: lists the names of the authors for the knowledge articles included in the search results list
  - Tags: lists the available knowledge tags
  - Resource: lists the types of items available, such as knowledge articles and social Q&A
  - Rating: lists article ratings from 0-5 stars (clicking a rating displays articles that have the selected rating and higher)
  - Last Modified: lists selections based on the timing of knowledge item modifications such as Past Month or Past Week
  - View Count: lists the knowledge item view counts such as More Than 50 or Less Than 10. Set the number of days to consider when calculating view count using the `glide.knowman.view_age.days` property.

### View additional search results

Depending on the system setup, view additional search results using one of these options:
- **Standard Pagination**: displays the search results in multiple pages.
- **Infinite Scroll**: displays the search results while scrolling.

---

**Note**: If a custom widget on the knowledge search results page uses the `KnowledgeSearchService` angular service, you must add the `sn.knowledgeApplication` dependency to enable the functionality of the custom widget.

1. Navigate to **Service Portal > Dependencies**.
2. In the **Name** field, search for the `sn.knowledgeApplication` dependency.
3. If a message appears, click **here** to edit.
   - You have to be in the **Knowledge Management - Service Portal** application to edit.
4. Click **Update**.

The search functionality in Knowledge Management Service Portal pages uses the **Knowledge Base Search** search context to fetch results. As an administrator, you must not update the definition of this context.
search context because it may impact the search behavior. For more information about contextual search, see Contextual search concepts.

Knowledge Management Service Portal article view page features

View the knowledge article you selected, including the article number, short description, and article content. Give feedback or comment on an article.

Note: If you select a question, the article view page displays the question, any answers to the question, and a text box for providing an answer.

Knowledge Management article view page

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breadcrumb</td>
<td>View which knowledge base the knowledge article is in.</td>
</tr>
<tr>
<td>Header</td>
<td>View the knowledge article number.</td>
</tr>
<tr>
<td>Subscribe</td>
<td>Click <strong>Subscribe</strong> to subscribe to the knowledge article. Unsubscribe by clicking <strong>Unsubscribe</strong>.</td>
</tr>
<tr>
<td>Overflow icon</td>
<td>Edit the knowledge article or flag an article that contains incorrect or inappropriate content.</td>
</tr>
<tr>
<td></td>
<td>Note: You must have Can Contribute access to the knowledge base and article.</td>
</tr>
<tr>
<td>Knowledge article content</td>
<td>View the text and images of the knowledge article. View who authored the article and when as well as the number of views the article has.</td>
</tr>
<tr>
<td>Copy Permalink</td>
<td>Click <strong>Copy Permalink</strong> to copy the URL of the latest article version to the clipboard.</td>
</tr>
<tr>
<td>Helpful?</td>
<td>Provide feedback on an article by marking it as helpful or not. View a percentage value of how many other users found the article helpful.</td>
</tr>
<tr>
<td>Rate this article</td>
<td>Rate a knowledge article.</td>
</tr>
<tr>
<td>Click here to comment to this article</td>
<td>Add a comment to an article</td>
</tr>
<tr>
<td>Attachments</td>
<td>View a list of article attachments if the <strong>Display Attachment</strong> field for the article is enabled.</td>
</tr>
<tr>
<td>Related Items</td>
<td>View a list of catalog items mapped to the article. The section appears only when the related catalog items are available for the selected article.</td>
</tr>
<tr>
<td>Related Articles</td>
<td>View a list of related articles with information similar to the selected article. The related articles are manually mapped, automatically predicted, or both. The manually mapped articles appear first in the section. The section appears only when the related articles are available for the selected article.</td>
</tr>
<tr>
<td>Affected Products</td>
<td>View a list of which products were affected.</td>
</tr>
<tr>
<td>UI component</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Most Recent tasks</td>
<td>View a list of tasks, such as incidents, cases, problems, and so on, recently associated with the article.</td>
</tr>
<tr>
<td>Most Useful</td>
<td>View a list of knowledge articles that users found most useful.</td>
</tr>
<tr>
<td>Search bar</td>
<td>Use the search bar to start a new search.</td>
</tr>
</tbody>
</table>

**Note:**
- If enabled, users can subscribe to articles, view article versions, and create feedback for articles that are rated as not helpful.
- The dynamic titles don’t apply to the knowledge article view page in the Knowledge Management Service Portal.

**Knowledge article URL parameters**
You can add parameters to an article URL to view the latest version and an existing translation.

**Knowledge article URL structure**
The knowledge article URL appears in the following structures:

- **Accessed from Service Portal:** [https://<instance-name>.service-now.com/kb?id=kb_article_view&amp;sysparm_article=<article number>&amp;sysparm_language=<language code>](https://<instance-name>.service-now.com/kb?id=kb_article_view&amp;sysparm_article=<article number>&amp;sysparm_language=<language code>)

  For example, the URL [https://yourbusiness.service-now.com/kb?id=kb_article_view&amp;sysparm_article=KB0010053&amp;sysparm_language=EN](https://yourbusiness.service-now.com/kb?id=kb_article_view&amp;sysparm_article=KB0010053&amp;sysparm_language=EN) returns the article with the most recent version in the selected language, if the translation for the selected language exists.

- **Accessed from Knowledge Base View (kb_view) UI page:** [kb_view.do?sysparm_article=<article number>&sysparm_language=<language code>](kb_view.do?sysparm_article=<article number>&sysparm_language=<language code>)

  For example, the URL [https://yourbusiness.service-now.com/kb_view.do?sysparm_article=KB0010044&amp;sysparm_language=en](https://yourbusiness.service-now.com/kb_view.do?sysparm_article=KB0010044&amp;sysparm_language=en) returns the article with the most recent version in the selected language, if the translation for the selected language exists.

**Note:** The listed parameters can include the sys_id in the url parameter.

**Parameters**
The following parameters are available for knowledge article URLs.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_article</td>
<td>Returns the most recent article version. For example, <a href="https://yourbusiness.service-now.com/kb?id=kb_article_view&amp;sysparm_article=KB0010053">https://yourbusiness.service-now.com/kb?id=kb_article_view&amp;amp;sysparm_article=KB0010053</a>.</td>
</tr>
</tbody>
</table>
Create a knowledge article

Knowledge contributors can create and edit knowledge articles within a knowledge base to share information across your organization.

You must have Can Contribute access to at least one active knowledge base.

To view an article template, you must activate the article templates feature and enable the desired templates.

Users with at least one role can create and edit knowledge articles. These users are known as knowledge contributors. Users without any role can read articles and submit feedback, but cannot create or edit articles.

If you try to create an article with more than 2 MB of data, the article might fail to create because of the Now Platform limitation.

Some knowledge bases may allow only certain users to contribute. For example, a member of the IT department can create knowledge articles in the IT knowledge base, such as desktop support information or articles describing company IT processes.

1. There are three ways of creating knowledge articles.
   - Navigate to **Self-Service > Knowledge** and click the Create an Article icon.
   - Navigate to **Knowledge > Articles > Create New**.
   - From the Knowledge Management homepage, click the Overflow icon and then Create Article.

2. On the Create new article page, select a knowledge base.
   The list of article templates to select in the next step is filtered according to the article templates available for the selected knowledge base.

   **Note:**
   On the Create new article page, you can select to **Switch to older version of this page** or **Switch to updated version of this page (recommended)**.

3. Select an article template.
4. Click **Next**.
   The Knowledge form is displayed based on the article template selected.
5. Fill in the fields on the form, as appropriate.

### Knowledge form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Base</td>
<td>The knowledge base selected for this article.</td>
</tr>
<tr>
<td></td>
<td>Note: An article can only be associated with one knowledge base.</td>
</tr>
<tr>
<td></td>
<td>You can change the knowledge base, but only if the selected article template is available in the knowledge base.</td>
</tr>
<tr>
<td>Category</td>
<td>The category for this article. Select a Knowledge Base before you can select a category. Articles without a category appear on the knowledge homepage in the (empty) category.</td>
</tr>
<tr>
<td>Ownership Group</td>
<td>The ownership group for this knowledge article. An ownership group consists of a group of members and a manager who are responsible for approvals, ensuring article quality, and feedback tasks. Ownership groups can publish, edit, and retire knowledge articles that they are associated with.</td>
</tr>
<tr>
<td></td>
<td>Note: If no ownership group is assigned, the article automatically goes to the knowledge administrator and knowledge manager for approval.</td>
</tr>
<tr>
<td>Language</td>
<td>Language in which you are creating the article. The list is populated based on the languages enabled for the selected knowledge base. This field appears only when the I18N:Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) is activated. For more information, see I18N - Knowledge internationalization.</td>
</tr>
<tr>
<td>Published</td>
<td>The date this knowledge article was published. This value is set when the article is published.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Valid to</td>
<td>The date this knowledge article expires. Articles do not appear in search results after the <strong>Valid to</strong> date or if the <strong>Valid to</strong> date is blank. The default value of the <strong>Valid to</strong> field is derived from the <strong>Article Validity</strong> field configured for the knowledge base (see Create a knowledge base). The <strong>Valid to</strong> date starts from the date the article was created until the number of days specified in the <strong>Article Validity</strong> field. If the <strong>Article Validity</strong> field is blank, the default date in the <strong>Valid to</strong> field for the knowledge article is set to January 1, 2100. An article author or editor can select whether to keep or change the default <strong>Valid to</strong> date. <strong>Note:</strong> If the system date format or user preferences is set to use “<strong>yy</strong>” year format, you might face issues when the <strong>Valid to</strong> date is set to the default date. Contact your system administrator or modify the user preferences to use a date format with the “<strong>yyyy</strong>” year format. For more information, see Global date and time field format and Personalize the system date format topics.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the article. This field appears only when the article versioning feature is enabled. For more information, see Article versioning.</td>
</tr>
<tr>
<td>Parent</td>
<td>Number of the article that represents the base language article. This setting keeps translations of the same article related to each other. Consider choosing the same language consistently for the parent article. This field appears only when the I18N:Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) is activated. For more information, see I18N - Knowledge internationalization. <strong>Note:</strong> The <strong>Parent</strong> field contains the first version of the parent article only. This field is used by the translation management feature to maintain the relationship between the source article and its translations.</td>
</tr>
<tr>
<td>Article type</td>
<td>The type of article, either HTML or wiki. <strong>Note:</strong> This field is only visible in the standard template.</td>
</tr>
<tr>
<td>Workflow</td>
<td>[Read-Only] The publication state of the article, such as <strong>Draft</strong>, <strong>In Review</strong>, or <strong>Published</strong>. When inserting a new article from an existing article, the state of the new article is reset to <strong>Draft</strong>.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field | Description
--- | ---
Source | The task this knowledge article was created in response to, if any. This field is set automatically when you create the knowledge article from a task record.
Attachment link | Check box for downloading an attached file automatically when a user accesses the article, instead of opening the article view. Add one or more attachments to the article to use this option.
**Note:** You may attach multiple files, but most web browsers permit users to download only the first one. To ensure download of all the files, bundle them into an archive, such as with WinZip, and attach the archive. The Attachment link option applies to articles accessed from search links only. Articles accessed from links within other knowledge articles will not automatically download an attached file.
Display attachments | Check box for displaying attachments to users viewing this knowledge article. Attachments appear below the article text. Add one or more attachments to the article to use this option.
Short description | The title of the article. This title appears when browsing and searching knowledge, and at the top of the article.
**Note:** If contextual search is enabled, the knowledge articles similar to the entered short description text appear in the Knowledge results section.
Article body | Content for the article. Use the HTML editor to create content. A preview of the content appears when browsing and searching knowledge.

6. Optional: To search for similar articles, type in the **Related Search** field or continue with the default text in the Knowledge Results section. If the Knowledge results section is not displayed on the Knowledge form, a system administrator can configure the form layout to add the **Contextual Search Results** field to the form.
   - To find knowledge articles that have high text similarity with the entered search text, choose Similar Articles (ML).
     **Note:** This option is available only when the Predictive Intelligence feature is enabled and your system administrator has trained the similarity solution for Knowledge Management. For more information, see [Train the similarity solution for Knowledge Management to find related articles](#)
   - To find knowledge articles that match the entered search text, choose Search Articles.

7. Optional: To view the entire article in a pop-up window, click the link to the article title.
8. Click Submit to create the article.
After saving the article record, you can add tags to further organize the article.

Any additional steps required to publish the article, such as approvals, depend on the publishing workflow for the knowledge base.

- If there is no approval workflow set up, the article is immediately published.
- If an approval workflow is set up and Ownership Group is configured, an email notification with a link to the article is sent to the ownership group members assigned to the article for approval.
- If an approval workflow is set up and Ownership Group is not configured, an email notification with a link to the article is sent to the knowledge base manager for approval.
- If the article is approved, it is published and an email notification is sent to the author or reviser of the article.
- If the article is rejected, an email notification is sent to the author or reviser of the article to revise and resubmit it for publishing.

**Edit a knowledge article**

Edit knowledge articles within a knowledge base to update information shared across your organization.

Role required: knowledge

Users with at least one role can edit knowledge. These users are known as knowledge contributors. Users without any role can read articles and submit feedback, but cannot edit articles.

However, knowledge managers can configure User Criteria to restrict access to certain knowledge bases. For example, only members of the IT department can create or edit knowledge articles in the IT knowledge base, such as desktop support information or articles describing company IT processes.

**Note:**

- If the article versioning feature is enabled, only the knowledge administrator, knowledge managers, and author can edit the checked-out version of an article. If the feature is disabled, any users with contribute access to an article can edit the draft version of the article. An administrator can disable the article versioning feature by setting the `glide.knowman.versioning.enabled` property (from the System Property [sys_properties] table) to `false`.
- If an article is associated with any ownership group, only ownership group members have contribute access to the article even if they don’t have contribute access to the knowledge base of the article. They can edit, approve, publish, and retire the knowledge article with which they are associated. For more information, see Ownership groups.
- If the `glide.knowman.translation.enable_translation_task` property is enabled, you can’t modify the knowledge base of existing articles.

1. Navigate to Knowledge > Articles.
2. Select an article from the Published or Unpublished category.
3. On the Knowledge form, click Edit.
4. If the article versioning feature is enabled, click Checkout for a published knowledge article.
   - You can only edit the latest version of a knowledge article.
5. Click Update.
   - When you edit a knowledge article, a default value appears in the Valid to field. You can select whether to keep or change the default Valid to date.

**Note:** If the article versioning feature is enabled, the default value of the Valid to date in the updated article version is automatically set based on the following criteria:
• If the **Article Validity** field in the knowledge base associated with the article is blank, the **Valid to** date value from the earlier version of the article is retained.
• If the **Article Validity** field in the knowledge base associated with the article is not blank, the **Valid to** date is automatically updated to start from the date the article was updated until the number of days specified in the **Article Validity** field (Article updated date + article validity).

If you move a knowledge article to another knowledge base, the default value of the **Valid to** date in the updated article is automatically set based on the following criteria:

• If the **Article Validity** field in the selected knowledge base is blank, the earlier **Valid to** date value is retained for the knowledge article.
• If the **Article Validity** field in the selected knowledge base isn’t blank, the **Valid to** date is automatically updated to start from the date the article was updated until the number of days specified in the **Article Validity** field (Article updated date + article validity).

If the dictionary value of the **Valid to** field is modified, this dictionary value overrides the default value of the **Valid to** field calculated according to the **Article Validity** field.

The article is saved. If the article versioning feature is enabled, the version of the knowledge article is incremented by 0.01. For more information, see Knowledge article version numbers.

6. Optional: Publish the article by clicking **Publish**.

The knowledge article is published depending on the workflow setting of its knowledge base:

• **Knowledge - Instant Publish**: The knowledge article is immediately published.
• **Knowledge - Approval Publish**: The knowledge article is published on approval completion.

When published, the knowledge article appears in the My Articles - Published and All Articles lists. If the article versioning feature is enabled, the version number of the knowledge article increments to the next whole number (for example, from 2.02 to 3.0). For more information, see Knowledge article version numbers.

**Map related articles**

Discover similar information across articles on a topic while viewing an article. You can manually map related articles or have the application automatically present related articles using machine learning (ML) algorithms.

Role required: knowledge

To edit the article, you must have knowledge contributor access for the associated Knowledge Base.

If you have manually mapped related articles when editing an article, those articles are listed in the Related Articles section on the knowledge article view page before the related articles that are predicted thorough the Knowledge Management similarity solution.

**Note:** An administrator can train the solution definition for Knowledge Management within the Predictive Intelligence feature to find related articles. For more information, see Train the similarity solution for Knowledge Management to find related articles.

This task provides steps to manually map related articles when editing an article.

1. On the Now Platform, open the knowledge article for which you want to map related articles.
2. On the Knowledge form, click the Related Articles related list.
3. Click **Edit**.
4. On the Edit Members form, move the desired articles from the available articles in the **Collection** column to the **Related Articles List** column.

5. Click the up or down icon to arrange the articles in the order in which you want them to appear in the **Related Articles section** on the article view page, and then click **Save**.

   **Note:** Knowledge administrators can configure the number of articles shown in the Related Articles section using the instance options.

---

**Map catalog items related to an article**

Manually map catalog items related to a knowledge article to enable employees to request the related product or service.

Role required: knowledge

To edit the article, you must have knowledge contributor access for the associated Knowledge Base.

1. On the Now Platform, open the knowledge article for which you want to map related catalog items.
2. On the Knowledge form, click the Related Catalog Items related list.
3. Click **Edit**.
4. On the Edit Members form, move the desired catalog items from the available catalog items in the **Collection** column to the **Related Catalog Items List** column.
5. Click the up or down icon to arrange the articles in the order in which you want them to appear in the **Related Items section** on the article view page, and then click **Save**.

   **Note:** Knowledge administrators can configure the number of catalog items shown in the Related Items section using the instance options.

---

**Comment on a knowledge article**

Comment on a knowledge article or reply to a comment.

Role required: Admin

1. Navigate to the Knowledge Management Service Portal.
2. Click the article you want to comment or reply to a comment on.
3. Click **Click here to comment on this article** or **Reply**.
4. Enter your comment or reply and add links, images, and attachments as required.

   **Note:** Attachments to comments posted in the Knowledge Management Service Portal are not displayed in the Live Feed. If attachments to comments are posted in Live Feed, they are displayed in the Knowledge Management Service Portal.

   If antivirus protection is enabled, all attachments are automatically scanned for viruses once the comment is posted. Attachments are only displayed once the scan is finished and successful.

   If you are the author of the comment, you can delete it. All comments and replies underneath are automatically deleted.

5. Click **Submit**.

   **Note:** You can only view comments in the Live Feed if the Use Live Feed for Knowledge feedback property is active. It is inactive by default.
Comments posted in Live Feed before upgrading to release version New York are not shown hierarchically in the Knowledge Management Service Portal. Comments posted in Live Feed after upgrading to release version New York are shown hierarchically in the Knowledge Service Portal.

The following table illustrates how comments and replies to comments are displayed depending on where you are viewing them.

<table>
<thead>
<tr>
<th>Viewing from</th>
<th>HTML formatting</th>
<th>Hierarchy</th>
<th>Attachments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Management Service Portal</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Live Feed</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Knowledge Management v3</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

Create knowledge from an incident, problem, or case

Create a knowledge article, so the next time the issue comes up the resolution is easy to find.

Depending on the value of the glide.knowman.submission.workflow property, knowledge created from an incident, problem, or case may require additional approval. When this property is true, a submission record is created instead of a knowledge article. A user with the knowledge role must approve the submission to create a knowledge article.

1. Open a resolved incident, problem, or case.
2. Select the Knowledge check box on the form.
3. Close the incident, problem, or case.
   A new draft knowledge article is created.
4. If additional approval is required, navigate to Knowledge > Open Submissions.
5. Select a submission record.
6. Review the submission to ensure the content and settings are correct.
7. Click Create Article.
   A new draft knowledge article is created. Articles created this way are added to the knowledge base specified in the property glide.knowman.task_kb.

Knowledge feedback

You can view and contribute to feedback on knowledge articles.

Feedback options

You can submit feedback for knowledge articles in these ways:

• Flag an article as incorrect or inappropriate.
• Provide a rating value for the article.
• Mark an article as helpful or not helpful.
• View comments, add a new comment, or reply to existing comments.

Users can view comments directly on the article. Knowledge managers can view the other types of feedback by navigating to Knowledge > Feedback.

Administrators and knowledge managers can disable some feedback options using fields on the Knowledge Base form. Administrators can configure feedback options using properties.

Flagging articles

You can flag an article for incorrect or inappropriate content. Click Flag Article in the article header to open a new window, allowing you to enter suggested changes.

• Flagged comments do not appear on the Article View page. Users with the admin, knowledge_admin, and knowledge_manager roles can access flagged articles by navigating to Knowledge > Articles > All Flagged. Users with the knowledge role can access their flagged articles by navigating to Knowledge > Articles > My Flagged.

• If disabled, the author of the article and users with the admin, knowledge_admin, and knowledge_manager roles can see all flagged comments. Other users can see only their own flagged comments.

Note: You cannot disable flagging for an article until you have disabled the flagging for all feedback comments for that article.

Flagged comments are stored in the Knowledge Feedback (kb_feedback) table but not the Live Feed Messages (live_message) table.

Rating articles

The five stars below the article title allow you to indicate the article's effectiveness on a scale of 1 to 5.

Marking articles

The question Helpful? at the bottom of the article allows you to indicate the usefulness of the article with a simple Yes or No answer. The Yes and No options are always available on the knowledge article view page even when you had selected an option earlier.

Comments

Knowledge comments at the bottom of the article use live feed to enable a conversation around a knowledge article. For example, you can post replies to comments, add attachments, or Like comments. The glide.knowman.use_live_feed property controls the display of knowledge article comments. If enabled, the system uses live feed to manage and display feedback on knowledge articles.

Note: Unauthenticated users and users with only the snc_external role can't add or view attachments for comments.

Import a Word document to a knowledge base

Import a Word document to create a knowledge article.
You must have **Can Contribute** access to at least one active knowledge base.

Role required: none

Beginning with Madrid, the Import a Word document feature is enabled by default and the Import Articles module is displayed in the application navigator. The Import a Word document feature isn’t enabled automatically for the existing customers who can continue using the Import Articles option on the Knowledge Management v3 homepage. To enable the Import a Word document feature for existing customers prior to Madrid, an administrator must first disable the Import Articles option on the Knowledge Management v3 homepage by setting the `glide.knowman.import.hide_import_functionality` property to true and adding the Import Articles module to the application navigator.

These styles and elements are preserved when importing a .doc or .docx file into a knowledge base. Styles and elements not included in this list may not be preserved when importing a document.

- **Titles**
- **Headings**

  - **Note:** Only default heading settings are supported. For any headings and subheadings with numbers, the numbers are not imported.

- **Images**

  - **Note:** Images may not be aligned exactly as in the Word document you import.

- **Links**
- **Bold text**
- **Italic text**
- **Underlined text**
- **Ordered and unordered lists**

  - **Note:** After import, the bullets in an unordered list are replaced with dots.

- **Tables**

  - **Note:** Only default heading settings are supported. Custom heading styles are imported using the default settings for those styles. Table styling and borders are not supported.

1. Navigate to **Knowledge > Articles > Import Articles.**
2. Enter the knowledge base to add the article to.
3. Optional: Select a **Category** from within the knowledge base.

  - **Note:** Use the category picker to add a category. The picker does not differentiate between the different category levels. You can select a category or sub category and add it to the **Category** field.

4. Optional: Select the **Publish** check box to start the publishing workflow for each imported article immediately after the import finishes.

  - **Note:** The Publish check box appears only when the **Show publish checkbox on the knowledge import pop-up** property is enabled. To enable the property, navigate to **Knowledge > Administration > Properties** and select the check box for the **Show publish checkbox on the knowledge import pop-up** property.

5. Select one or more Word files to import.
6. Click **Import**.
   An article is created in the selected knowledge base and category using the content from the uploaded document.
   - If you uploaded multiple documents, one article is created for each.
   - If you use knowledge internationalization, the language of the article is set to the system language selected.
   - When the upload completes, a pop-up window displays the number and short description of the articles. Click an article to view the full record.
   - If any errors occur during the upload, a pop-up window displays the error.
   - If the **Publish** check box is activated, knowledge articles go into **Review** or **Published** state, depending on the workflow attached to the knowledge base.
   - If the **Publish** check box is not activated, the knowledge articles go into **Draft** state and are then reviewed before publishing.

**Create an article version by importing a Word document**

Import a Word document to a knowledge article to create a new version.

- Ensure that the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is installed.
- You can only upload new versions to articles that are in **Draft** or **Published** state.
- You cannot upload new versions to articles that are created using an article template or if the article type is **Wiki**.

Role required: admin

1. Navigate to **Knowledge > Articles**.
2. Click an article.
3. Click the **Upload New Version** related link.

   **Note:** Any text written in TinyMCE is overwritten once the file is imported.

4. Add the file you want to import.
5. Optional: Select the **Copy Attachments** check box to copy all attachments to the knowledge article.

   **Note:** If the article is published, the attachments are added to a new article version. If the article is in draft, the attachments are added to the existing knowledge article. The draft article does not appear in the knowledge base (KB) for users until it is reviewed and published.

6. Click **Import**.
   A draft version is created and sent to approvers to approve or reject. Once the article is approved, it is displayed in the **Article Versions** related list.

**Social Q&A question view page**

View the question you selected as well as any answers. Answer a question or give feedback to a question.
How long does it usually take to set up my router?

Let's face it: Each router is different, and getting the right combination of settings, while setting up the router can be confounding. For example, even some reasonably experienced PC hands may not understand the differences between security settings or know that WPA-2 offers better protection than WEP and ordinary WPA.

With these considerations in mind how long does it usually take to setup my routers?

Various vendors have tried to make things simpler with easy-setup CDs or one-click connection buttons, but they can not cover every possible circumstance. Router setup instructions go the extra mile by explicitly detailing the order in which you need to you plug everything in before you run the CD. (Cable modems in particular should be powered on before you connect your router to them.) That is a nice touch -- but it assumes you have read the printed instructions that came with the router. This helps in setting up the router relatively quickly.
Social Q&A question view page

<table>
<thead>
<tr>
<th>No.</th>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Question</td>
<td>Displays the question and answers and meta data.</td>
</tr>
<tr>
<td>2</td>
<td>Vote</td>
<td>Provide feedback on a question by voting it up or down.</td>
</tr>
<tr>
<td>3</td>
<td>Comment, Share</td>
<td>Share the question via Connect or email and comment on a question.</td>
</tr>
<tr>
<td>4</td>
<td>Edit</td>
<td>Knowledge managers or question owners can edit their questions.</td>
</tr>
<tr>
<td>5</td>
<td>Answer</td>
<td>Lists the answers to the question.</td>
</tr>
<tr>
<td>6</td>
<td>Comment</td>
<td>Comment on an answer.</td>
</tr>
<tr>
<td>7</td>
<td>Edit</td>
<td>Knowledge managers or question owners can edit their answers to the question.</td>
</tr>
<tr>
<td>8</td>
<td>Accept</td>
<td>Knowledge managers and question owners can click Accept to mark an answer as the correct answer.</td>
</tr>
<tr>
<td>9</td>
<td>Your Answer</td>
<td>Type your answer to the question and click Submit.</td>
</tr>
<tr>
<td>10</td>
<td>Ask a Question</td>
<td>Click Ask a Question to ask a question in the community.</td>
</tr>
<tr>
<td>11</td>
<td>Question Stats</td>
<td>Lists when the question was created, how many subscribers it has, and how many views it has had.</td>
</tr>
</tbody>
</table>

Knowledge subscriptions

Subscribe to knowledge bases and knowledge articles and receive email notifications about new articles and article revisions or comments.

- **Subscribed to a knowledge base:**
  - Knowledge base owners are auto-subscribed to all articles in the knowledge bases they own. They receive email notifications when new articles are created or revised (published) in the knowledge base.
  - Users who subscribe to a knowledge base receive email notifications when new articles are created in the knowledge base or if the existing articles are revised (published).

- **Subscribed to a knowledge article:**
  - Knowledge authors are auto-subscribed to the articles they create. They receive email notifications when the articles they created are checked out or revised (published) by other authors, and if the articles receive user comments.
  - Users who subscribe to an article receive email notifications when the article is revised (published).

Users can set their Knowledge notification preferences using **System Settings**.

The knowledge subscription feature is available for both the Knowledge Management v3 user interface and the Knowledge Management Service Portal.
If the article versioning feature is enabled, the following notifications are also sent:

- An article is checked out
- An article is revised
- A new version of an article is published

**Activation information**

The knowledge subscriptions feature requires the Knowledge Management Advanced plugin (com.snc.knowledge_advanced). For more information, see Configure knowledge subscriptions.

**Subscribe to a knowledge base**

Subscribe to a knowledge base and receive notifications when articles are added to that knowledge base.

Role required: knowledge

Users can subscribe to a knowledge base from either the Knowledge Management v3 user interface or the Knowledge Management Service Portal.

1. Navigate to Knowledge > Homepage.
2. Click the Subscribe link on the knowledge base tile.
   The link changes to Subscribed and includes a check mark.

**Unsubscribe from a knowledge base**

Unsubscribe from a knowledge base.

Role required: knowledge

Users can unsubscribe from a knowledge base from either the Knowledge Management v3 user interface or the Knowledge Management Service Portal.

**Note:** If you subscribe to an article and then subscribe to the knowledge base, unsubscribing from the knowledge base also unsubscribes you from the article.

1. Navigate to Knowledge > Homepage.
2. Point to and click the Subscribed link on the knowledge base tile, which toggles to Unsubscribe. After unsubscribing you from the knowledge base, the link toggles to Subscribe.

**Subscribe to a knowledge article**

Subscribe to a knowledge article within a knowledge base.

Role required: knowledge

Users can subscribe to a knowledge article from either the Knowledge Management V3 user interface or the Knowledge Management Service Portal.

**Note:**

Users who are already subscribed to a knowledge base are also subscribed to the articles within that knowledge base.
To subscribe to articles from the base service portal (https://<instance name>/sp?), you must navigate to the Knowledge Management Service Portal pages (for example: https://<instance name>/sp?id=kb_home) from the base service portal.

1. Navigate to **Knowledge > Homepage**.
2. Click **Subscribe** at the top of the knowledge article.
   The system shows an information message about the article subscription and the button toggles to **Subscribed**. If the email notification contains an article link, the link points to the Knowledge Management Service Portal.

### Unsubscribe from a knowledge article

Unsubscribe from a knowledge article.

Role required: knowledge

Users can unsubscribe from a knowledge article from either the Knowledge Management v3 user interface or the Knowledge Management Service Portal.

**Note:** If you are subscribed to a knowledge base and you unsubscribe from an article in that knowledge base, you must also unsubscribe from the parent knowledge base.

1. Navigate to **Knowledge > Homepage**.
2. Point to and click **Subscribed**, which toggles to **Unsubscribe**.
   If you are subscribed to the knowledge article, this action results in an information message that the article subscription has been removed. If you are also subscribed to the parent knowledge base, proceed to the next step.
3. If you are subscribed to the parent knowledge base, click **Yes** on the Unsubscribe pop-up window.
   This action results in an information message that the knowledge base subscription has been removed.

### Set knowledge notification preferences

Set notification preferences for knowledge bases and knowledge articles.

Role required: knowledge

Users can set notification preferences from the Knowledge menu or from the Knowledge Management Service Portal.

1. Navigate to the Notification Settings page.

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Knowledge application</td>
<td>Click the <strong>Notification Settings</strong> module.</td>
</tr>
<tr>
<td>From the Knowledge Management Service Portal</td>
<td>Click the user name in the portal header and then click <strong>Notification Settings</strong>.</td>
</tr>
</tbody>
</table>

2. Click the **Notification Preferences** tab.
3. Click **Knowledge Base** and enable or disable the knowledge base notification options.
4. Click **Knowledge Articles** and enable or disable the knowledge article notification options.

### Manage knowledge subscriptions

Manage knowledge base and knowledge article subscriptions from the Notification Settings page.

Role required: knowledge
Users can manage knowledge subscriptions from the Knowledge application or from the Knowledge Management Service Portal.

1. Navigate to the Notification Settings page.

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Knowledge application</td>
<td>Click the Notification Settings module.</td>
</tr>
<tr>
<td>From the Knowledge Management Service Portal</td>
<td>Click the user name in the portal header and then click Notification Settings.</td>
</tr>
</tbody>
</table>

2. Click the Subscriptions tab.
3. Click Knowledge Base or Knowledge Articles to see a list of current subscriptions.
4. To unsubscribe from a knowledge base or knowledge article, click Subscribed. The link toggles to Unsubscribed.

Knowledge blocks

Simplify knowledge authoring for writers and knowledge consumption for readers with knowledge blocks. Knowledge blocks are reusable pieces of content secured by user criteria that you can add to knowledge articles in a knowledge base. The user criteria controls which users can read or not read the block content in an article or search, enabling users to more easily view content that is relevant to them.

How to use knowledge blocks

To use knowledge blocks, a knowledge administrator or manager must enable the knowledge blocks feature for each knowledge base in which the blocks will be used.

• Enable knowledge blocks for each knowledge base

Knowledge contributors can create knowledge blocks and insert them into articles in a knowledge base:

Note: Knowledge blocks are not supported in article templates and articles of type wiki.

• Create a knowledge block
• Add knowledge blocks to a knowledge article
• Preview a knowledge article with knowledge blocks by user or date

Knowledge block content can be read or not read in an article or search based on user criteria set at the knowledge base and knowledge block level. See Select user criteria for a knowledge block for more information.

Holiday calendar with location-specific knowledge block content

You are part of an enterprise HR organization that maintains a company knowledge base. You want to create a holiday calendar so that employees know which days of the year are company holidays. Since the company has multiple locations and holiday dates vary based on where the employee is located, there are several ways that you could create the knowledge article.

One way is that you could create a knowledge article for each location, with an article for Location A, Location B, and so on.

• Pros: simplified consumption. Employees have a single article to search for and read.
• Cons: more work for HR. HR has multiple articles to manage and update for each location where the company has employees.
Another way is that you could create a single knowledge article that includes sections for each location.

- **Pros**: simplified authoring. HR has a single article to manage and update.
- **Cons**: more work for employees. Employee must scroll through and disregard extraneous content to find the section in the article that pertains to them.

With knowledge blocks, you can create a single knowledge article with location-specific block content secured by user criteria. This approach helps to reduce the workload for both HR and employees. As an HR agent, you have a single article to manage and update. Employees have a single article to search for and read, with the user criteria ensuring that they only view content that is relevant to them.

### If you are using a custom search or knowledge article viewer

If you are using a custom search or knowledge article viewer with your application, you should integrate it with the appropriate knowledge or knowledge blocks API. (Integration is only necessary if you are using a custom search or knowledge article viewer.)

- Integrating a custom search or knowledge article viewer with knowledge blocks

### Activation information

To use knowledge blocks in your application, you must activate knowledge blocks. For information on what components are installed with the feature, see Components installed with knowledge blocks.

**Note:** Activating knowledge blocks automatically activates Knowledge Management Advanced, which enables advanced features such as article versioning. Knowledge blocks can be used with or without the article versioning feature. To disable the feature, see Disable the article versioning feature.

### Activate knowledge blocks

You can activate knowledge blocks [com.snc.knowledge_blocks] if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Role required:** admin

Knowledge blocks activates these related plugins if they are not already active.

#### Plugins for knowledge blocks

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Management Advanced</td>
<td>Enables advanced features for Knowledge Management, such as article versioning. For a full list of features, see activate the Knowledge Management Advanced plugin.</td>
</tr>
<tr>
<td>[com.snc.knowledge_advanced]</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Knowledge blocks can be used with or without the article versioning feature. To disable the feature, see Disable the article versioning feature.

1. Navigate to **System Applications > All Available Applications > All.**
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.*

Components installed with knowledge blocks
Several types of components are installed with activation of the knowledge blocks plugin, including tables.

   **Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Block</td>
<td>Knowledge blocks table.</td>
</tr>
<tr>
<td>[kb_knowledge_block]</td>
<td></td>
</tr>
</tbody>
</table>

   **Note:** This table extends the Knowledge [kb_knowledge] table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>KB Knowledge to Block</td>
<td>KB knowledge to block table.</td>
</tr>
<tr>
<td>[m2m_kb_knowledge_to_block]</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>KB Knowledge to Block History</td>
<td>KB knowledge to block history table.</td>
</tr>
<tr>
<td>[m2m_kb_to_block_history]</td>
<td></td>
</tr>
</tbody>
</table>

For further information on table administration and how to manage data, see Table administration.

Enable knowledge blocks for each knowledge base
Enable the knowledge blocks feature for each knowledge base where you plan to use the blocks. Once enabled, you can create knowledge blocks to add to knowledge articles within a knowledge base.

Make sure that the knowledge blocks [com.snc.knowledge_blocks] plugin is activated.

Role required: knowledge_admin or knowledge_manager

1. Navigate to **Knowledge > Administration > Knowledge Bases**.
2. Open the knowledge base record.
3. In the Knowledge Base form, select the **Enable blocks** check box.

**Note:** If the **Enable blocks** check box is not visible, you can add the field to the form by right-clicking the form header and navigating to **Configure > Form Layout**.

4. Click **Update**.

**Note:** If you decide to later disable the knowledge blocks feature, all knowledge blocks within the knowledge base must be deleted before you can clear the box.

Create knowledge blocks to use within the enabled knowledge base.

**Create a knowledge block**

Create or modify a knowledge block to define a reusable piece of content that can be inserted into knowledge articles in a knowledge base. The knowledge block is secured by user criteria, which controls what users, groups, roles, companies, locations, or departments can read or not read the content in an article or search, enabling users to more easily view content that is relevant to them.

Role required: user must have contributor access to the knowledge base.

1. Navigate to **Knowledge > Knowledge Blocks > Create New**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

## Knowledge Block form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>This field is automatically set to a knowledge block number.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Name of the knowledge base.</td>
</tr>
<tr>
<td>Category</td>
<td>Name of the knowledge category or subcategory.</td>
</tr>
<tr>
<td>Ownership Group</td>
<td>Ownership group for the knowledge block. This field appears when the ownership groups feature is enabled.</td>
</tr>
<tr>
<td>Can read</td>
<td>User criteria to apply for read access at the knowledge block level.</td>
</tr>
<tr>
<td>Cannot read</td>
<td>User criteria to apply for cannot read access at the knowledge block level.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date that the knowledge block expires. After the valid to date:</td>
</tr>
<tr>
<td>Short Description</td>
<td>Description of the knowledge block.</td>
</tr>
<tr>
<td>Text</td>
<td>Text of the knowledge block.</td>
</tr>
</tbody>
</table>

**Note:** The knowledge blocks feature must be enabled for each knowledge base that you plan to create blocks. See [Enable knowledge blocks for each knowledge base](#).

**Note:** Knowledge blocks can be used with or without the ownership groups feature. To learn more about ownership groups, including how to enable the feature, see [Ownership groups](#).

**Note:** User criteria set at the knowledge base and knowledge block level controls which users can read or not read block content within an article. To learn more about selecting user criteria for a knowledge block, see [Select user criteria for a knowledge block](#).

**Note:** User criteria set at the knowledge base and knowledge block level controls which users can read or not read block content within an article. To learn more about selecting user criteria for a knowledge block, see [Select user criteria for a knowledge block](#).

- Knowledge article viewer will no longer display expired knowledge block content in the associated knowledge article.
- Search will no longer return knowledge articles if the keywords are contained in the expired blocks.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>This field is automatically set to a version number when the article versioning feature is enabled.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Knowledge blocks can be used with or without the article versioning feature. To learn more about article versioning, including how to disable the feature, see Article versioning.</td>
</tr>
<tr>
<td>Article type</td>
<td>This field is automatically set to HTML.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Knowledge blocks are only supported with HTML knowledge articles.</td>
</tr>
<tr>
<td>Workflow</td>
<td>This field is automatically set to the publication state of the block, such as Draft, Published, or Retired.</td>
</tr>
<tr>
<td>Source task</td>
<td>Not applicable.</td>
</tr>
</tbody>
</table>

4. Click **Save** or **Update** to create or update the block.
5. Click **Publish** to publish the block.

**Note:** Any additional steps required to publish the knowledge block, such as approvals, depend on the publishing workflow for the knowledge base. See Knowledge workflows for more information.

After the knowledge block is published, you can add the block to an article within the knowledge base. **Select user criteria for a knowledge block**

Control which users can read or not read knowledge block content within an article in a knowledge base by setting user criteria at the knowledge base and knowledge block level. As a knowledge contributor, you can apply user criteria at the knowledge block level.

Role required: user must have contributor access to the knowledge base.

1. Navigate to **Knowledge > Knowledge Blocks > All.**
2. Open a knowledge block.
3. Apply the desired user criteria for the **Can Read** and **Cannot Read** fields.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can Read</td>
<td>User criteria to apply for read access at the knowledge block level.</td>
</tr>
<tr>
<td>Cannot Read</td>
<td>User criteria to apply for cannot read access at the knowledge block level.</td>
</tr>
</tbody>
</table>

**Note:**
- You can use existing or create new user criteria records. To create a new record, see Create a user criteria record in Knowledge Management.
- If a user meets any **Can Contribute** criteria at the knowledge base level, they can read all knowledge block content, regardless of the **Can read** and **Cannot read** criteria set at the knowledge block level.
- If a user meets any **Cannot read** criteria at the knowledge block level, they cannot read the block content, regardless of the **Can read** criteria set at the knowledge block level.
User meets any of the following:
- admin role
- knowledge_admin role
- knowledge base owner
- knowledge base manager
- Can Contribute user criteria
  (if no user criteria is set, then any user with at least one role can contribute articles.)

1. Can Contribute access at knowledge base level?
   - No
     - Can Read access at knowledge base level?
       - No
         - Cannot read block
       - Yes
         - Can read block
   - Yes
     - Can read access at block level?
       - Yes
         - Can read block
       - No
         - Cannot read block

2. (if no user criteria is set, then any user can read articles.)
4. Right-click the form header and click **Save**.

   • To finish and publish the block, see *Create a knowledge block.*
   • To add the block to an article, as well as preview the article by impersonating different users, see *Add knowledge blocks to a knowledge article.*

*Retire a knowledge block*

You can retire a published knowledge block so that it is no longer available for users to view or search. A knowledge block can only be retired if it is not being used in any knowledge articles.

Role required: user must have contributor access to the knowledge base.

1. Navigate to **Knowledge > Knowledge Blocks > Published.**
2. Open the applicable record.
3. In the **Articles** related list, verify that the knowledge block is not being used in any knowledge articles.

   **Note:** A knowledge block can only be retired or deleted if it is not being used in any knowledge article, including any retired article or previous version of an article.

4. Click **Retire** to retire the knowledge block.

   **Note:** Any additional steps required to retire the knowledge block, such as approvals, depend on the workflow for the knowledge base. See *Knowledge workflows* for more information.

*Add knowledge blocks to a knowledge article*

You can insert one or more knowledge blocks into a knowledge article within a knowledge base. Each knowledge block is secured by user criteria, which controls who can read or not read the content in an article.

Role required: user must have contributor access to the knowledge base.

1. Navigate to **Knowledge > Articles > All.**
2. Click **New** or open a record.
3. Fill in the fields on the form, as appropriate.

   For further details on creating a knowledge article, see *Create a knowledge article.*

   **Note:** Knowledge blocks are only supported with HTML knowledge articles. Make sure that the **Article type** field is set to **HTML.**
4. Click **Add Blocks** to open the **Add Blocks** side panel.

**Note:** If the **Add Blocks** button is not visible, make sure that the knowledge blocks feature is enabled for the knowledge base that the article is in. See [Enable knowledge blocks for each knowledge base](#) for more information.
5. In the **Add Blocks** side panel, you can search for, do an advanced search, view, and insert knowledge blocks into the article. You can also create blocks directly from the side panel.

**Note:** If there are knowledge blocks you cannot find, make sure that the blocks are published, in the same language, and in the same knowledge base as the article.

6. In the **Article body**, you can rearrange knowledge blocks within an article.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are using a mouse</td>
<td>a. Click the block to select it.</td>
</tr>
<tr>
<td></td>
<td>b. Drag and drop the block within the article.</td>
</tr>
<tr>
<td>Option</td>
<td>Steps</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>If you are using a keyboard</td>
<td>a. Place your cursor to the left of the block.</td>
</tr>
<tr>
<td></td>
<td>b. Press the right arrow key to select the block.</td>
</tr>
<tr>
<td></td>
<td>c. Use Ctrl+x and Ctrl+v to cut and paste the block within the article.</td>
</tr>
</tbody>
</table>

The following GIF shows an example of a user moving a knowledge block within an article using a keyboard.
List ready for your next day off! Here's a list of company holidays in your region:

- **KBB0010002**
  Company Holiday Calendar - Location A

- **KBB0010003**
  Company Holiday Calendar - Location B
7. Click **Save** or **Update** to create or update the article.

   **Note:** You can preview the article with the blocks by user or, if published, date. See Preview a knowledge article with knowledge blocks for more information.

8. Click **Publish** to publish the article.

   **Note:** Any additional steps required to publish the knowledge article, such as approvals, depend on the publishing workflow for the knowledge base. See Knowledge workflows for more information.

---

**Preview a knowledge article with knowledge blocks**

Preview a knowledge article with knowledge blocks by user or, if published, by date. For an unpublished article, you can preview the article by user by impersonating different users to see how the article displays or hides block content (based on the user criteria set at the knowledge base and knowledge block level). For published articles, you can preview the article by both user and date to see how the article appears in past versions for different users.

Role required: user must have contributor access to the knowledge base.

1. Navigate to **Knowledge > Articles**, and open one of the modules, such as **Unpublished** or **Published**.
2. Open the knowledge article with knowledge blocks.
3. In the Related Links section, click Preview Article with Blocks.

4. Preview the article as one of the following.

<table>
<thead>
<tr>
<th>Option</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unpublished article</td>
<td>Preview the article by user. In the View As field, you can search for and impersonate different users to see how the article appears based on the can and cannot read access of the user.</td>
</tr>
</tbody>
</table>
Preview a knowledge article with blocks by different users

The author is previewing the article as different users in different locations. Ashley Aoto sees the block content for Location A, Beth Berry sees the block content for Location B, and Claire Chaganti sees the block content for Location C.
Company Holiday Calendar

KB0010004 46 views

Employees in Location A have the following company holidays.

- Mon, January 1 - New Year's Day
- Mon, February 19 - Presidents' Day
- Mon, May 28 - Memorial Day
- Wed, July 4 - Independence Day
- Mon, September 3 - Labor Day
- Thurs, November 22 - Thanksgiving
- Tues, December 25 - Christmas Day
- Mon, December 31 - New Year's Eve

Employees in Location B have the following company holidays.

- Mon, January 26 - Republic Day
- Tues, May 1 - May Day
- Fri, June 15 - Eid Ul Fitr
- Wed, August 15 - Independence Day
- Thurs, September 13 - Ganesh Chaturthi
- Tues, October 2 - Ghandi Jayanthi
- Wed, November 7 - Diwali
- Tues, December 25 - Christmas Day

Employees in Location C have the following company holidays.

- Mon, January 1 - New Year's Day
- Fri, March 30 - Good Friday
- Mon, April 2 - Easter Monday
- Mon, May 7 - Early May Bank Holiday
Integrating a custom search or knowledge article viewer with knowledge blocks

If you are using a custom search or knowledge article viewer with your application, you can integrate that custom search or viewer with the appropriate knowledge or knowledge blocks API.

**Note:** Integration is only necessary if you are using a custom search or knowledge article viewer.

**KBPortalServiceImpl - Global**

The `KBPortalServiceImpl` API is included with Knowledge Management V3 [com.snc.knowledge3] as a script include. It provides methods to use with knowledge, such as integration with a custom search.

**KBPortalServiceImpl - KBPortalServiceImpl()**

Instantiates a `KBPortalServiceImpl` object in a global application.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**KBPortalServiceImpl - getResultData(Object request)**

Returns search results based on keywords from the knowledge article and from relevant knowledge block content that the user has access to read.

If you have activated the knowledge blocks feature and are using a custom search for knowledge with your application, your search may not return relevant articles when keywords are contained in the blocks. To return search results based on keywords from the article and from relevant block content that the user has access to read, you must call the `getResultData()` method inside your custom search.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>request</td>
<td>Object</td>
<td>JSON object to refine the search.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array</td>
<td>Array of search results in JSON format based on keywords from the knowledge article and from relevant knowledge block content that the user has access to read.</td>
</tr>
</tbody>
</table>

**Integrating a custom search with knowledge blocks**

```javascript
function doKeywordSearch(queryText, count, queryLocation) {
    var results = [];

    // To set up the request.
    var request = {
        keyword: queryText,
        language: "",
        // To pass data to filter on different metadata.
        variables: {
```
```javascript
kb_knowledge_base: ['Knowledge'],
kb_category: '',
author: [''],

// Provide the following.
context: gs.getProperty('glide.knowman.sp.search_context', 'Knowledge Search'),
resource: 'Knowledge',
order: "relevancy,true",

// Provide the pagination variables.
start: queryLocation,
end: queryLocation+count,
attachment: false,

// Provide any additional metadata you want to include in your results.
knowledge_fields: [
  "number",
  "sys_id",
  "published"
]

// To execute the search.
var response = new KBPortalServiceImpl();
response.getResultData(request);

// To send the search results back to the UI or to store results in your object.
for (var i = 0; i < response.results.length; i++) {
  result = response.results[i];
  var article = {};
  article.sys_id = result.meta.sys_id.display_value;
  article.number = result.meta.number.display_value;
  article.short_description = article.short_description;
  article.title = result.title;
  article.published = result.meta.published.display_value;
  article.publishedUTC = result.meta.published.display_value;
  article.text = article.text;
  article.score = result.meta.score;
  article.label = article.short_description;
  article.shortDescription = article.short_description;
  results.push(article);
}
return results;
```

**KBBlock - Global**
The KBBlock API is included with knowledge blocks [com.snc.knowledge_blocks] as a script include. It provides methods to use with the knowledge blocks feature, such as integration with a custom knowledge article viewer.

**KBBlock - KBBlock()**
Instantiates a KBBlock object in a global application.
KBBlock - getArticleContent(GlideRecord knowledgeRecord)
Gets knowledge articles with relevant knowledge block content that a user has access to read.

If you have activated the knowledge blocks feature and are using a custom knowledge article viewer with your application, your viewer may not display articles that expand the relevant block content. To expand block content that a user has access to read, you must call the getArticleContent() method inside your custom viewer.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>knowledgeRecord</td>
<td>GlideRecord</td>
<td>GlideRecord of the knowledge article to display.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Knowledge article with relevant knowledge block content that a user has access to read.</td>
</tr>
</tbody>
</table>

Integrating a custom knowledge article viewer with knowledge blocks

```javascript
// This function returns the article text with expanded block content.
function getArticleText(kbSysId) {
    var knowledgeRecord = new GlideRecord('kb_knowledge');
    var kbText='';
    if(knowledgeRecord.get(kbSysId)) {
        if(new GlidePluginManager().isActive('com.snc.knowledge_blocks')) {
            kbText = new KBBlock();
            kbText.getArticleContent(knowledgeRecord);
        } else
            kbText = knowledgeRecord.getValue('text');
    }
    return kbText;
}

// This is an example of how to call the function defined above.
var kbText = getArticleText('01alca5b6710130038876c3b5685efd3');
```

Knowledge Management V3 homepage

The Knowledge Management V3 homepage displays knowledge articles and social Q&A questions organized by knowledge base and category, as well as featured content and popular articles.

To view the default knowledge homepage, navigate to **Self-Service > Knowledge**.
Note:
The knowledge homepage is not compatible with Internet Explorer 9 or earlier. Using one of these browsers will cause you to be redirected to the legacy knowledge portal.
The Knowledge V3 home page is not customizable. Use the Knowledge Management Service Portal for an easily configurable user experience.

If you access knowledge from a service management application, the knowledge homepage for the associate application opens.

Only published and not yet expired knowledge articles (that is the valid do date not yet reached) appear on the homepage.

From the homepage, you can import a Word document to a knowledge base using the Import Articles button.

Note: From Madrid, you can import a word document from the Import Articles module available in the Application Navigator. This feature is active by default for customers on Madrid and later releases. Existing customers on release versions prior to Madrid use the Word import functionality on the Knowledge V3 homepage. Upgrade customers use the Word import functionality on the Knowledge V3 homepage by default. If required, add the Import Articles module to the Application Navigator. If you add the module, the Import Articles button does not appear on the Knowledge V3 homepage.

You can also create a new article using the Create An Article button, or ask a question using the Post a Question button.
- Import a Word document
- Create an article
- Ask a question

Note: You must have user criteria "Can contribute" permission for at least one active knowledge base, otherwise these buttons do not appear. See Migrate to Knowledge Management v3 and Knowledge manager.

You can select a knowledge base to browse articles and questions within that knowledge base. You can view only knowledge bases you can access.

Articles and questions are organized by category or by tag. Categories are listed alphabetically. While browsing, you can filter content by type to view only knowledge articles, only social Q&A questions, or only unanswered questions. You can sort content by most recent update or by number of views.

You can comment on an article. There is no HTML formatting available for comments on the Knowledge V3 homepage.

Existing customers on release versions prior to New York can view knowledge article feedback comments in the following ways.
- On the Knowledge V3 homepage.
- If the Knowledge Management — Service Portal plugin (com.snc.knowledge_serviceportal) is installed, on the Knowledge Service Portal.
- If the Use Live Feed for knowledge feedback property is active, in the Live Feed.

For new customers on New York and later releases, comments can only be viewed in the Knowledge Service Portal.
An administrator can configure the knowledge homepage to display the number of articles and questions within each category. This count includes articles and questions from subcategories. To display the article and question count, set the knowledge homepage property `Display or hide the count of articles and questions in the category and child categories (glide.knowman.show_number_on_categories)` to true.

**Search using Knowledge Management v3**

Search for knowledge articles and social Q&A questions from the knowledge homepage using the search bar on the Knowledge Management v3 homepage.

Search results include only articles and questions you are authorized to read. The search results count do not take into consideration any security rules set for the articles. The number of articles you can access may be lower than the count displayed in the search results page. Documents that are attached to articles are also listed in the search results.

**Note:** To change how the attachments are displayed in the search results, set the `How to display attachments in Knowledge Search Results glide.knowman.search.attachment` property. Attachments can be displayed with a snippet, link only, or not at all.

To use wildcards in your search, navigate to **Contextual Search > Search Contexts > Knowledge Base Search** and select **Enable wildcard searches**.

Sort knowledge content by relevancy, most recent update, or number of views.

Filter results using the check boxes that appear. Filtering options appear depending on the search text.

**Filtering options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Select if you want to view knowledge articles, social Q&amp;A questions, or both. This option is only available if Social Q&amp;A is enabled.</td>
</tr>
<tr>
<td><strong>Knowledge Bases</strong></td>
<td>Select a knowledge base to search. You can select only knowledge bases you can access. If you do not select a specific knowledge base, search results include articles and questions from all knowledge bases that you can access. You can also select a knowledge base from the choice list in the search bar. For pinned articles, only those in the selected knowledge base in the corresponding language appear.</td>
</tr>
<tr>
<td><strong>Categories</strong></td>
<td>Select one or more knowledge categories. Categories are listed alphabetically.</td>
</tr>
<tr>
<td><strong>Authors</strong></td>
<td>Select one or more authors.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Language</th>
<th>Description</th>
</tr>
</thead>
</table>

The multi-language search feature is available when more than one supported language is enabled.

1. To enable multi-languages, activate the I18N: Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) or activate one of the internationalization plugins for the language you require.

    **Note:** Activating internationalization plugins for any of the available languages automatically activates the I18N: Knowledge Management Internationalization Plugin v2 plugin.

2. To display search results in all available languages simultaneously, enable the glide.knowman.enable_multi_language_search property.

    a. Navigate to Knowledge > Administration > Properties > Knowledge Search Properties > Enable multi language search and select the Yes check box.

    b. Enter sys_properties.list in the filter navigator, search for the property to configure, and in the Value field, enter true.

    **Note:** By default, the glide.knowman.enable_multi_language_search property is not enabled. Search results are displayed based on the language you select in the language filter on the Search page.

---

### Import a Word document to a knowledge base using Knowledge Management V3

Import a Microsoft Word document using Knowledge Management v3 homepage to create a knowledge article.

You must have user criteria "Can contribute" permission for at least one active knowledge base.

The import articles button does not appear in the following conditions:

- The Import Articles module is available in the application navigator.

    **Note:** Beginning with Madrid, the Import a Word document feature is enabled by default and the Import Articles module is displayed in the application navigator. The Import a Word document feature isn’t enabled automatically for the existing customers who can continue using the **Import Articles** option on the Knowledge Management v3 page. For more information, see Import a Word document to a knowledge base.
• You cannot contribute to any knowledge base.

**Note:** An administrator can control the visibility of the **Import Articles** button by setting the other knowledge property **Hide the 'Import' functionality (button and drag-n-drop) for all users (glide.knowman.import.hide_import_functionality)** to true.

**Role required:** None

You can import Microsoft Word .doc and .docx files.

**Note:** The file extension must be lowercase.

When you import a document, text content from the document is used to create the knowledge article. The articles support all editing functions supported by the TinyMCE editor. All HTML supported by TinyMCE such as tables, lists, and links, as well as styling such as bold and italics, are preserved. Images from the document are added as attachments to the knowledge article and embedded in the article body.

**Note:**
You can import multiple files at a time. Closing the browser or navigating away cancels any in-progress uploads but does not delete articles created from completed imports.

You cannot import documents to knowledge from mobile devices.

The following styles and elements are preserved when importing a .doc or .docx file into a knowledge base. Styles and elements not included in this list may not be preserved when importing a document.

• Titles
• Headings

**Note:** Only default heading settings are supported. For any headings and subheadings with numbers, the numbers are not imported.

• Images

**Note:** Images may not be aligned exactly as in the Word document you import.

• Links
• Bold text
• Italic text
• Underlined text
• Ordered and unordered lists

**Note:** After import, the bullets in an unordered list are replaced with dots.

• Tables

**Note:** Only default heading settings are supported. Custom heading styles are imported using the default settings for those styles. Table styling and borders are not supported.

1. Navigate to **Self-Service > Knowledge**.
2. Perform one of the following actions.
   • Click **Import Articles** and select one or more document files.
   • Drag one or more document files onto the knowledge homepage.

3. Select the **Knowledge base** to add the new article to.
   You can select only knowledge bases you can contribute to.

4. Optional: Select a **Category** from within that knowledge base.

   **Note:** Use the category picker to add a category. The picker does not differentiate between the different category levels. You can select a category or sub category and add it to the **Category** field.

5. Optional: Select the **Publish** check box to start the publishing workflow for each imported article immediately after the import finishes.

   This check box applies only when importing to v3 knowledge bases and only if the **Show publish checkbox on the knowledge import pop-up** property is set to **Yes** on the Knowledge Management properties form. You cannot automatically publish articles imported to v2 knowledge bases.

   Knowledge v2 articles go into **Draft** state. Knowledge v3 articles go into **Review** or **Published** state, depending on the workflow attached to the knowledge base (Approval Publish or Instant Publish).

6. **Click Import.**

   A new article is created in the selected knowledge base and category using the content from the uploaded document. If you uploaded multiple documents, one article is created for each. If you use knowledge internationalization, the language of the new article is set to the currently selected system language.

   After the upload completes, a popup window appears displaying the number and short description of the newly-created articles. Click an article to view the full record.

   If any errors occur during the upload, a popup window appears to display the error.

**Select a knowledge article category**

Knowledge articles within a knowledge base are grouped by category. These groups can help you define the knowledge base taxonomy, and can help users find articles within that knowledge base.

As a knowledge contributor, when editing a knowledge article you can select categories using the Category picker, and add or edit categories if enabled for the knowledge base.

1. Click the reference lookup icon beside the **Category** field.
2. Select an existing category, or click the add category icon (+) to add a new category.

   After you select a category, you can click the pen icon to rename that category. Press the enter key or click outside the selected category to save the change.

   **Note:** Clicking **Cancel** while selecting a category cancels selecting a new category, but does not revert any changes you make to the categories such as renaming or adding new categories.

3. Fill in the fields on the form, as appropriate.
4. Optional: Select or add a subcategory.
5. **Click OK.**
Move a knowledge article

You can move articles between knowledge bases.

1. Edit a knowledge article.
2. Change the Knowledge Base field value.
   After moving an article, the Apply Default Values dialog box prompts you to populate certain fields in the article with default values from the new knowledge base. If the new knowledge base has no default values, the dialog box does not appear.
3. Click OK to overwrite fields with the default values, or Cancel to leave all fields unchanged.

   A knowledge manager can define default values for articles in knowledge bases you manage using the Set default knowledge field values field on the Knowledge Base form.
4. Click Update.

Retire a knowledge article

You can initiate the retirement workflow to retire a knowledge article. Only administrators and knowledge administrators can view articles after they are retired.

A knowledge article has an associated retirement workflow, similar to the publishing workflow. This allows administrators to configure these workflows, defining an approval and review process for retiring knowledge if appropriate.

When editing an article, click Retire to launch the retirement workflow associated with that article. If the article requires approval prior to retirement, the article goes to a pending approval state, and the workflow either finishes upon approval or cancels if rejected by a required approver. The article number associated with the retired article is not available for reuse.

Note:
- Retired knowledge articles are not available to users except for administrators and knowledge administrators who can view them. To reuse a retired article, administrators and knowledge administrators can republish the article. For more information, see Republish a retired article.
- An article and its translations have a parent-child relationship. Retiring a parent article does not automatically retire all its translated child articles.
Instant retire and Approval retire workflows

Republish a retired article

Instantly republish a retired article.

Role required: admin or knowledge admin
There may be cases where you'll need to republish a retired article. For example, an admin may want to temporarily retire an article when its information doesn't currently apply, but will at a later date. An administrator or knowledge administrator who can view retired articles can instantly republish these without having to go through an approval workflow.

1. Navigate to **Knowledge > Articles > Retired**.
2. Select a retired article and click **Republish**.

The article is instantly published as the previous last published version.

**Create a knowledge article from a customer service case**

Reuse information from a customer service case by creating knowledge articles from cases.

Your administrator must enable creation of articles from customer service cases.

Role required: sn_customerservice_agent or knowledge

1. Navigate to **Customer Service > Cases > All**.
2. Select a case from which you want to create a knowledge article.
3. Click **Create Knowledge**.
   - The relevant fields are automatically copied from the case to the record that opens.
4. In the **Knowledge base** field, enter the name of the knowledge base in which you want this article to display.
5. Click **Submit**.

**Request a knowledge base**

If existing knowledge bases do not fit your needs, you can request a new knowledge base through the service catalog. If the request is approved, you are added as the owner of the new knowledge base.

Role required: none

If no knowledge base exists that fit your needs, all users can request a new knowledge base.

1. Navigate to **Self-Service > Service Catalog**.
2. Select **Can We Help You?**.
3. Select the **Request Knowledge Base** catalog item.
4. Enter the reason you want the knowledge base, and a name for the knowledge base.
5. Click **Submit**.

You are notified when the request is approved or rejected. If the request is approved, you are added as the owner of the new knowledge base. You can then assign managers and manage articles in the new knowledge base.

Knowledge bases created through this request process are inactive by default, so you must activate the knowledge base to make it available for users.

**Use knowledge on mobile devices**

All users can access knowledge from mobile devices to search for and view knowledge articles and social Q&A questions.

**Browse knowledge on mobile devices**

You can browse knowledge bases using a mobile device.

Navigate to **SELF-SERVICE > Knowledge Base**.
Mobile Knowledge View

Browse Knowledge by tapping on a category and browsing articles or subcategories.
Mobile Knowledge Categories

**Note:** Select the desired category and click the close icon (X) for the selected category to reflect in the search results.

**View knowledge articles and questions on mobile devices**

You can read knowledge content using a mobile device.

Tap a title to view the article or question.
Note: You cannot edit or add comments to knowledge articles on the mobile interface. If using Social Q&A, you can perform all functions such as adding and editing questions, answers, and comments through the mobile interface.

Mobile Knowledge Article View

Search knowledge on mobile devices
Find a specific article or question by searching on a particular term.
Translation management

Manage multi-language knowledge bases by using automated translation tasks and translation APIs. Translate published knowledge articles in languages configured for the knowledge base containing the articles.

When you log in to an instance, after entering your credentials, you can choose a default language. The list of languages are listed based on the internationalization language plugins you have installed.

Knowledge articles are authored and published in various languages. As an administrator you can configure the required languages for a knowledge base and ensure that users can create articles only in the configured languages.

The translation management feature allows you to translate published knowledge articles that are missing translations manually or by using the machine translation option to automatically translate the knowledge article. This feature creates translation tasks automatically for the languages you have specified. You can configure assignment rules and auto-assign tasks for a language, knowledge base, or category to a translator or a group of translators.

The translation management feature is available only if you have installed required plugins and set a system property.
The required plugins are:

- Knowledge Management Advanced plugin
- I18N:Knowledge Management Internationalization Plugin v2 or Internationalization language plugins

Enable the `glide.knowman.translation.enable_translation_task` property to display the following Translation Management menu items:

- All Open Tasks
- My Assigned Tasks
- Translator Mapping

Enable languages for a knowledge base

You can select the languages you want enabled at a knowledge base level. Users can then create articles only for selected languages.

Role required: knowledge_admin or admin

1. Navigate to Knowledge > Administration > Knowledge Bases.
2. Click New or select an existing knowledge base.
3. Click the lock icon to unlock the Languages field.
4. Select the languages from the list.

**Note:**
You can also remove languages from the list if you decide that you do not want to create a translation task in that language.

5. Click Submit or Update.

Create translation assignments

To ensure accurate translations, you can assign knowledge articles to language experts. Identify the language experts and create assignment rules to automatically assign translation tasks to language experts and groups.

Role required: knowledge_admin or admin

Assignment rules are applied only if the task is not already assigned to another user or group.

1. Navigate to Knowledge > Translation Management > Translator Mapping.
2. Click New to create a new assignment rule or select an existing rule to modify.
3. Enter a name for the assignment rule in the Name field.
4. In the Applies To tab, perform the following.
   a) Select a table from the Table dropdown for example, Knowledge Translation Task [kb_translation_task].
   b) Specify the conditions that must be met before the task is assigned to the user or group.
5. Click Submit.
6. In the Assign To tab, and select the user or group you want to assign the task to and click Submit. An email notification is sent to the translator with a link to the translation task and source article.
7. Click the Script tab to enter a script to further customize the assignment rule.
8. Click Submit.

Note: To cancel a task, add an appropriate reason for cancellation in the Cancellation notes field and click Cancel.

Auto-create translation tasks

Manage multi-language knowledge bases by using automated translation tasks and translation APIs. Translate published knowledge articles in languages configured for the knowledge base containing the articles.

Role required: knowledge_admin or admin

The available languages are determined by the language plugins you have installed.

1. Navigate to Knowledge > Administration > Knowledge Bases.
2. Click New or open an existing knowledge base.
3. Select Auto-create translation tasks. Tasks are created for languages you have configured. If Auto-create translation tasks is unchecked, you must create the tasks manually after the article is published.
4. Click Submit or Update.

Note: Open a knowledge article and click Knowledge Translation Tasks related list to view the associated translation tasks.

Translate a knowledge article

You can start translating articles once they are published and assigned to you for translation.

Role required: admin, knowledge_admin, or knowledge

1. Navigate to Knowledge > Translation Management > My Assigned Tasks.
2. In the Knowledge Translation Tasks page, select one of the listed translation tasks assigned to you.
3. Click **Translate**.

   **Note:** If you want to do a translation directly from an article, use the **Translate** related link on the article page.

   The **Translate from** and **Translate to** panes are side-by-side for easy viewing, as shown in the following figure.

![](image)

4. Click **Machine translate**, which automatically translates to the targeted languages.

   **Note:** A default translator configuration should be available. For configuring the translation API, see Dynamic Translation.

5. Click **Create draft article** to create a draft version of the translated article.

   If a translated article is already present for that language, a new draft version overwrites an existing translated content.

6. Click **Publish**.

   The newly created draft is listed in the **Translated Versions** tab.
Translate knowledge blocks within an article

Knowledge blocks added to an article must be translated first before translating an article.

Role required: translator

If a selected article indicates that a knowledge block is missing a translation, you must translate the knowledge block before you can translate the article.

1. Navigate to Knowledge > Translation Management > My Assigned Tasks.
2. In the Knowledge Translation Task page, select a translation task and click Translate.

Note: A message stating that the knowledge article contains one or more knowledge blocks that have missing translations is displayed.

3. Click on the link in the message to view the list of blocks that require translation.
4. Click the translation task again and click Translate.

Note: The newly translated blocks appears in the Translated Block Versions related list.

Request missing translations for available languages

Create translation tasks manually for missing languages through the Request Translations option. The option is available even if the auto-create translation task option is enabled.

Role required: admin

Verify that the glide.knowman.translation.enable_translation_task property is set to true.

1. Navigate to Knowledge > Articles > Published.
2. Select an article from the list of published articles.
3. From the article, click Request translations.
4. Select the missing languages and click Submit.

Note: If a task is already open for a particular language, you cannot select the same language again.

The translation tasks for the article are created and listed in the Knowledge Translation Tasks tab.

Now Mobile for Knowledge Management

Access knowledge articles from anywhere using the Information applet on the Now Mobile app. You can view recently viewed and most popular articles, search for articles, browse articles by category, and provide feedback for articles.

To access articles from the Information applet on the Now Mobile app, you must first download the ServiceNow mobile application on an iOS platform from the Apple App Store or on an Android platform from the Google Play Store.
Make sure your administrator has activated the Now Mobile app. For more information, see Activate Now Mobile app.

After you access an article, you can view the author, published date, number of views, and the overall rating details of the article. In addition, you can respond to and evaluate articles and view related items and related articles.

Activation information

The Information applet is available on the Now Mobile app. The ServiceNow Mobile Request - Knowledge Management Screens and Applet Launcher plugin (com.glideapp.knowledge.mobile_requestor) activates the Information applet. The Information applet is activated by default for both new and upgrade customers.
View the most popular or recently viewed articles in the Now Mobile Information applet

The Information applet on the Now Mobile app enables you to access knowledge articles from a mobile device.

You can specify user criteria for an article to control which users can read the article. If no user criteria is defined for an article, all users can read the article.

1. Access your instance using the mobile application.
2. On the Now Mobile app, tap Information.
3. Access your recently viewed or the most popular knowledge articles

### Information applet article views

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recently Viewed</td>
<td>Up to five of the articles you viewed within the last 30 days.</td>
</tr>
<tr>
<td>Popular</td>
<td>Up to five of the most popular knowledge articles. The Now Mobile app homepage includes a similar section that displays up to three of the most popular articles.</td>
</tr>
</tbody>
</table>

**Note:** Tap See All to view the complete list of articles within the selected section.

Browse articles in the Now Mobile Information applet

You can browse articles within a category in the Now Mobile Information applet to see articles related to a particular subject or grouping.

You can specify user criteria for an article to control which users can read the article. If no user criteria is defined for an article, all users can read the article.

1. Access your instance using the mobile application.
2. On the Now Mobile app, tap Information.
3. In the Browse section, tap a category from the categories list to view articles and child categories associated with the selected category.

**Note:** Tap See All to view the complete categories list.
4. Tap further categories until you view the articles list associated with the desired category. The articles associated with a parent category are grouped under a dummy child category labeled as Other.

5. To view an article, tap the article in the articles list.

Search for an article in the Now Mobile Information applet

You can search for an article in the Now Mobile Information applet.

You can specify user criteria for an article to control which users can read the article. If no user criteria is defined for an article, all users can read the article.

1. On the Now Mobile app, tap Information.
2. Tap Search for Services, Articles or People, and enter a search term related to the article.
3. Tap the search icon on your app keyboard.
   The app displays search results.
4. Tap Articles to view only articles in the search results.
5. Tap an article in the search results to view the article content.

View an article in the Now Mobile Information applet

You can view the author, published date, number of views, and the overall rating details of the article in the Now Mobile Information applet. In addition, you can respond to and evaluate articles and view related items and related articles.

You can specify user criteria for an article to control which users can read the article. If no user criteria is defined for an article, all users can read the article.

Note: Any attachments to the article are not viewable in the Information applet.

1. On the Now Mobile app, tap Information.
2. Search for or select the desired article from the sections available in the Information applet. The article page displays the content and associated information for the selected article such as author, published date, number of views, and the overall rating. The page also displays the following sections:

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Articles</td>
<td>Up to five related articles that are manually mapped, automatically predicted, or both. The manually mapped articles appear first in the Related Articles section. This section appears only when related articles are available for the selected article.</td>
</tr>
<tr>
<td>Related Items</td>
<td>Up to five related items that are manually mapped. This section appears only when related items are available for the selected article.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** Tap **See All** to view the complete list of articles within the selected section.

3. Optional: Respond to and evaluate the article.

**Respond to and evaluate articles in the Now Mobile Information applet**

You can contribute to feedback on knowledge articles by rating an article, marking an article as helpful or not helpful, and posting and replying to comments for an article in the Now Mobile Information applet.

You can specify user criteria for an article to control which users can read the article. If no user criteria is defined for an article, all users can read the article.

1. On the Now Mobile app, tap **Information**.
2. Select the desired article.
3. Contribute to the article feedback by rating it, marking it as helpful or not helpful, or leaving a comment.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate the article</td>
<td>Tap the star icons displayed on the article. You can also rate an article that appears within the Related Articles section by tapping the star icons next to the number of times the article was viewed.</td>
</tr>
<tr>
<td>Mark an article as helpful or unhelpful</td>
<td>Tap the helpful icon (👍) or the not helpful icon (👎).</td>
</tr>
<tr>
<td>Post a comment</td>
<td>Enter a comment in the Comments section and click <strong>Submit</strong>.</td>
</tr>
<tr>
<td>View all comments and replies posted for the article</td>
<td>Scroll down to the Comments section.</td>
</tr>
<tr>
<td>Like a comment on the article</td>
<td>Underneath a comment, tap the like icon (👍).</td>
</tr>
<tr>
<td>Reply to a comment on the article</td>
<td>Underneath a comment, tap the reply icon (✍️), enter your comment in the text box that appears, and then tap <strong>Submit</strong>.</td>
</tr>
</tbody>
</table>
Migrate to Knowledge Management v3

Knowledge Management has significantly changed with the introduction of knowledge v3 starting with the Fuji release.

Knowledge Management v3 has several key differences from Knowledge Management v2, the version of Knowledge Management that was available until Eureka release. The knowledge v3 plugin is activated by default starting with the Fuji release.

The following podcast provides more information on what is new in Knowledge Management v3.

When upgrading from Eureka or earlier versions, if you intend to use the new features available in knowledge v3, you have to migrate legacy knowledge content and any customizations you have made to the Knowledge Base applications.

The following video provides more information on how to migrate from Knowledge Management v2 to v3.

<table>
<thead>
<tr>
<th>Key differences</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Legacy Knowledge</strong></td>
</tr>
<tr>
<td>One knowledge base.</td>
</tr>
<tr>
<td>A single lifecycle workflow shared by all articles.</td>
</tr>
<tr>
<td>Two-level organizational structure with Topic and Category. A single organizational taxonomy shared by all articles.</td>
</tr>
<tr>
<td>Permissions defined per article using roles and ACLs.</td>
</tr>
</tbody>
</table>

Knowledge Management v3 migration process

When you upgrade from Eureka or earlier, consider a multi-step migration process. This process ensures you can access existing knowledge content and allows you to fully migrate at your own pace.

Review automatic changes before upgrading. These changes are applied immediately when upgrading and may impact existing functionality.

1. Migrate knowledge functionality to use your customized functionality with the Knowledge Management v3 enhancements.

2. Migrate knowledge content to use the Knowledge Management v3 enhancements with your existing knowledge articles.
After migration to Knowledge Management v3

These items are relevant to getting the full range of new functionality after you migrate.

- You must configure knowledge access controls based on user criteria to ensure that users can access existing knowledge content. Since access control in knowledge v3 is intended to be based on user criteria alone, users may be unable to access v2 or v3 knowledge articles, or have restricted access, with preexisting ACLs.
- If the home page was customized in knowledge v2, custom layout and links are not saved in knowledge v3.
- Images added using the Image field in a knowledge article form do not display in the Knowledge v3 or Knowledge Service Portal pages. The article search results page displays the knowledge base icon next to all articles from the knowledge base.

Automatic changes after Knowledge Management v3 migration

Upgrading to Knowledge Management v3 automatically changes knowledge functionality including the knowledge user interface and security model.

Default knowledge base

When you upgrade from Eureka or earlier, a default knowledge base is created, titled Knowledge, that contains all knowledge articles from the previous version.

After the upgrade, you can add and edit articles in this knowledge base.

Articles in the default knowledge base continue to use legacy functionality, such as role-based access controls. Any customizations you made to knowledge functionality before the upgrade are preserved in the default knowledge base.

Knowledge search changes

By default, the legacy knowledge portal uses knowledge v3 search with limited filtering options.

You can filter results only by knowledge base. Search results include only those articles the current user can view based on user criteria. ACLs do not restrict search results.

Knowledge security changes

Knowledge v3 manages access to articles with user criteria rather than roles and ACLs.

Existing ACLs on the Knowledge [kb_knowledge] table are preserved, but with the following changes.

- A version of 3 indicates that a knowledge base uses the knowledge v3 functionality.
- A version of 2 indicates that a knowledge base uses legacy functionality.

New ACLs introduced by knowledge v3, such as field-level controls, apply to all knowledge bases.

When you upgrade from Eureka or earlier, any custom ACLs you implemented for the Knowledge table still apply to any knowledge records in the default knowledge base. Knowledge v3 updates ACLs that exist before upgrade so they only apply to Knowledge [kb_knowledge] records where this field value is 2.

**Note:** These changes affect the default knowledge base. Even if you are not using the new knowledge functionality, the legacy knowledge behavior may change if you have made customizations to ACLs on the Knowledge [kb_knowledge] table. Ensure you configure knowledge access controls after upgrading to prevent unexpected behavior.
To control access to knowledge articles, try to use user criteria, which were introduced in Knowledge Management v3. For more information, see Select user criteria for a knowledge base.

Knowledge article view changes
The Knowledge application uses the kb_view UI page to display knowledge articles.

UI page
The following changes apply automatically when you upgrade from Eureka or earlier:

- The existing kb_view page is renamed to kb_view_customer. The kb_view_customer page is used to display articles in the default knowledge base, preserving the legacy user experience.

  Note: By default, the kb_view_customer page is publicly accessible. As an administrator, you can change this behavior by modifying the sys_public table record for this page and clearing the Active field in the record.

- A new kb_view page is used. This is becomes the primary page used to display articles that are not in the default knowledge base.

You should review all customizations introduced around the legacy kb_view UI page.

- URLs should not be updated as the new kb_view page redirects to the correct page depending on the article.
- Customizations made to the kb_view UI page are automatically copied to the kb_view_customer page on upgrade.
- Other customizations that affect kb_view may need to be copied or modified to apply to kb_view_customer. For example, an ACL defined for kb_view may need to be duplicated to provide security coverage for kb_view_customer.

Feedback
Legacy feedback functionality is retained for knowledge articles displayed in the legacy article view. Users can continue to use the feedback options to view, add, and reply to comments on these legacy articles. Legacy comments are retained in the Knowledge Feedback [kb_feedback] table.

To retain the legacy comment functionality with new knowledge articles, set the Use Live Feed for Knowledge feedback property (glide.knowman.use_live_feed) to false. This property is set to false by default.

Knowledge portal changes
While the legacy knowledge portal, kb_home, has not changed in Knowledge v3, we strongly recommend that you consider moving to the new Knowledge v3 home page, $knowledge.do.

UI page
You can search articles from the knowledge portal and filter search results by knowledge base, and by language if the instance uses knowledge management internationalization. This portal also appears for users on older browsers, such as Internet Explorer 9, instead of the knowledge homepage.

Navigation add-ons are available in the legacy knowledge portal. Navigation add-ons of the Link type appear in the top-right of the portal. To add navigation add-ons of the Search type, you must customize the kb_home UI page.
Search

By default, the legacy knowledge portal uses knowledge v3 search with limited filtering options. You can filter results only by knowledge base. Search results include only those articles the current user can view.

Knowledge submissions

Knowledge submissions created from tasks continue to work in knowledge v3 with minor changes.

By default, the Topic and Category fields no longer appear on the Submission form due to the knowledge v3 category changes.

The property `glide.knowman.submission.workflow` no longer appears on the knowledge properties UI page. To enable knowledge submissions, set this property to true on the System Properties [sys_properties] table.

See creating knowledge from incidents and problems for instructions on using knowledge submission in knowledge v3.

Migrating Knowledge access controls

Access to knowledge articles is controlled based on the user criteria for the knowledge base.

**Important:** If you do not migrate existing knowledge ACLs to user criteria, users may be unable to access knowledge articles, or may be able to access restricted articles.

User criteria records, rather than ACLs, control basic create, read, update, and delete operations for knowledge articles as well as which search results appear. This may lead to unexpected behavior if your configuration depends on ACLs to control access.

To ensure users are able to access the correct knowledge articles, migrate any ACL-based security settings to user criteria. This process may include creating additional knowledge bases and moving existing content to these knowledge bases, depending on your security model. For a detailed explanation and migration examples, refer to KB0550924 Understanding User Criteria and ACLs in Knowledge v3.

This video demonstrates how to manage article-level access controls during migration from Knowledge Management v2 to v3.

Knowledge functionality migration

You can migrate knowledge functionality to use your customized functionality with the knowledge v3 enhancements.

Replaced knowledge modules

When you are ready to migrate to knowledge v3, you can activate the v3 modules and deactivate the legacy modules.

Use the tables below to identify which knowledge v3 modules to activate and which legacy modules to deactivate. When activating a knowledge v3 module, deactivate the knowledge v2 module with the same name to ensure users access the correct module.

You can use the `enablev3anddisablev2menus.txt` backup script to enable knowledge v3 menus and disable knowledge v2 menus.

<table>
<thead>
<tr>
<th>Title</th>
<th>Order</th>
<th>Link type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Homepage</td>
<td>100</td>
<td>URL (from Arguments:)</td>
</tr>
<tr>
<td>Title</td>
<td>Order</td>
<td>Link type</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Articles</td>
<td>200</td>
<td>Separator</td>
</tr>
<tr>
<td>Create New</td>
<td>300</td>
<td>New Record</td>
</tr>
<tr>
<td>Unpublished</td>
<td>400</td>
<td>List of Records</td>
</tr>
<tr>
<td>Published</td>
<td>500</td>
<td>List of Records</td>
</tr>
<tr>
<td>Retired</td>
<td>600</td>
<td>List of Records</td>
</tr>
<tr>
<td>Flagged</td>
<td>800</td>
<td>List of Records</td>
</tr>
<tr>
<td>All</td>
<td>900</td>
<td>List of Records</td>
</tr>
<tr>
<td>Open Submissions</td>
<td>960</td>
<td>List of Records</td>
</tr>
<tr>
<td>Administration</td>
<td>1000</td>
<td>Separator</td>
</tr>
<tr>
<td>Knowledge Bases</td>
<td>1100</td>
<td>List of Records</td>
</tr>
<tr>
<td>Feedback</td>
<td>1300</td>
<td>List of Records</td>
</tr>
<tr>
<td>Ratings</td>
<td>1500</td>
<td>List of Records</td>
</tr>
<tr>
<td>Search Log</td>
<td>1600</td>
<td>List of Records</td>
</tr>
<tr>
<td>Navigation Add-ons</td>
<td>1700</td>
<td>List of Records</td>
</tr>
<tr>
<td>Messages</td>
<td>1800</td>
<td>List of Records</td>
</tr>
<tr>
<td>Properties</td>
<td>1900</td>
<td>URL (from Arguments:)</td>
</tr>
<tr>
<td>Overview</td>
<td>2000</td>
<td>URL (from Arguments:)</td>
</tr>
<tr>
<td>User Criteria</td>
<td>2100</td>
<td>List of Records</td>
</tr>
</tbody>
</table>

**Legacy modules**

<table>
<thead>
<tr>
<th>Title</th>
<th>Order</th>
<th>Link type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create New</td>
<td>100</td>
<td>New Record</td>
</tr>
<tr>
<td>Published</td>
<td>190</td>
<td>List of Records</td>
</tr>
<tr>
<td>Edit</td>
<td>200</td>
<td>List of Records</td>
</tr>
<tr>
<td>Retired</td>
<td>240</td>
<td>List of Records</td>
</tr>
<tr>
<td>Feedback</td>
<td>300</td>
<td>List of Records</td>
</tr>
<tr>
<td>View</td>
<td>400</td>
<td>URL (from Arguments:)</td>
</tr>
<tr>
<td>Submissions</td>
<td>410</td>
<td>Separator</td>
</tr>
<tr>
<td>Assigned to me</td>
<td>420</td>
<td>List of Records</td>
</tr>
<tr>
<td>Open Submissions</td>
<td>450</td>
<td>List of Records</td>
</tr>
<tr>
<td>KCS</td>
<td>460</td>
<td>List of Records</td>
</tr>
<tr>
<td>Flagged Articles</td>
<td>470</td>
<td>List of Records</td>
</tr>
<tr>
<td>Ratings</td>
<td>480</td>
<td>List of Records</td>
</tr>
<tr>
<td>Searching Log</td>
<td>495</td>
<td>List of Records</td>
</tr>
</tbody>
</table>
## Knowledge article publish and retire workflows

With knowledge v3, article state is controlled by workflows.

In the legacy knowledge base, article state was controlled by UI actions. UI actions from previous versions are available only in the default knowledge base.

To preserve your article publishing and retirement process in new knowledge bases, create workflows that follow these processes. To create these workflows, copy the default workflow that best matches your process and modify that copy. After creating workflows that use your article publishing and retirement processes, use these workflows as the **Publish workflow** and **Retire workflow** for the new knowledge bases.

## Knowledge article category structure

With knowledge v3, all knowledge articles are organized by category and subcategory within knowledge bases.

The default knowledge base uses the legacy category structure; knowledge articles are organized by topics and categories.

Before you migrate articles, create a category structure for these articles in the destination knowledge bases. This structure can reproduce your legacy topic and category structure or can be extended to take advantage of the knowledge v3 category functionality.

## Knowledge content migration

To use the new functionality available in knowledge v3 with legacy articles, you must migrate these articles out of the default knowledge base.

To migrate knowledge content, move articles out of the default knowledge base by changing the **Knowledge Base** value for each article. The state of the article remains unchanged when moving articles. After selecting a new knowledge base, assign a category to each article using the category structure defined in the new knowledge base.

After you migrate a knowledge article, the legacy feedback functionality is automatically replaced with the new knowledge feedback mechanisms. Legacy feedback is copied to the Live Feed Message [live_message] table to ensure previously submitted feedback is available for knowledge v3 articles.

## Social Q&A

If Social Q&A is activated for a knowledge base, you can ask questions and respond to questions from other users. You can also vote on helpful questions and answers.

Social Q&A extends the Knowledge application. All questions and answers are associated with a knowledge base. Social Q&A uses Knowledge access controls, search, and the knowledge homepage.

Social Q&A is available on mobile devices using the mobile knowledge interface. You can perform all Social Q&A functions on mobile, such as asking and answering questions.
Enable social Q&A for a knowledge base

As a knowledge manager, you can enable social Q&A for a knowledge base you manage.

Role required: knowledge_manager

You can set the limit for the number of times users can post questions, answers, and comments, or subscribe to the questions using the Knowledge Social Q&A properties section.

All Social Q&A questions and answers are associated with a knowledge base. The Enable social questions and answers check box on the Knowledge Base form controls if users can view and ask questions.

Social Q&A uses user criteria from the knowledge base to determine which users have access to questions.

1. Navigate to Knowledge > Knowledge Bases.
2. Select a knowledge base you manage.
3. Select the Enable social questions and answers check box.
   - This check box only appears if the Social Q&A plugin has been activated.
4. Click Update.

You can disable Q&A for a knowledge base by clearing the Enable social questions and answers check box. Disabling Q&A does not delete existing questions and answers associated with this knowledge base, but prevents users from browsing or searching for those questions and answers.

Social Q&A questions

Social Q&A organizes information by question.

You can browse and search for questions from the Knowledge homepage (Self-Service > Knowledge). Questions appear along with knowledge articles organized by knowledge base, category, and tags.

Click on a question to view the question details, as well as responses and comments. You can add responses and comments, vote on existing responses, share questions, and edit your own questions and answers from the question details. Click on a picture profile to view the user’s profile.

Ask a social Q&A question

As a Social Q&A user, you can ask questions that other users can respond to.

Roles required: None

1. Navigate to Self-Service > Knowledge.
2. Click Post a Question.
3. Enter a value for the following fields.

Question fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter the question you have.</td>
</tr>
<tr>
<td>Question details</td>
<td>Enter additional details about the question that may help other users provide an answer.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Knowledge base | Select the knowledge base this question relates to. You can select only knowledge bases configured to allow Q&A.
Category | Select the knowledge category this question relates to. You can select only categories within the selected knowledge base. Questions without a category appear on the knowledge homepage in the (empty) category.
Tags | Enter one or more tags that describe the question.

4. Click **Post Question**.

To accept the answer, click the **Accept** link from within the answer. The accepted answer moves to the top of the list of answers. You can unaccept an answer by clicking **Unaccept**.

#### Note: You must be the owner of the question or the knowledge manager to accept an answer.

### Answer a question

As a user, you can answer a question another user has asked. The owner of the question can then accept the answer.

Roles required: None

As the owner of a question, you can accept an answer as the correct answer. That answer then appears above other answers for the question.

1. Navigate to **Self-Service > Knowledge**.
2. Select a question.
3. Enter an answer in the **Your answer** field.
4. Click **Submit**.

### Comment on a question or answer

You can comment on a question or an answer to provide additional information relevant to that question or answer.

Roles required: None

1. Navigate to **Self-Service > Knowledge**.
2. Select a question.
3. Within the question or answer you want to comment on, click the **Comment** link.
4. Enter the comment text.
   - Comments have a maximum length of 140 characters.
5. Click **Post comment** or press the Enter key.

### Edit a question, answer, or comment

You can edit questions, answers and comments you submit, or in knowledge bases you manage.

Role required: None

1. Navigate to **Self-Service > Knowledge**.
2. Select a question.
3. Within the question, answer, or comment you want to edit, click **Edit**.
4. Edit the details as needed.
5. Optional: When editing a question, click **Advanced** to make changes to the question record.
6. Click **Update**.
   Click **Undo** to discard the changes and close the editor.

**Vote on a question or answer**

As a Social Q&A user you can vote on a question or answer to promote it.

Role required: None

Vote up questions that you want users to answer, and answers that you believe accurately resolve questions. Alternatively, vote down questions that you do not find useful, or answers that you believe are incorrect. You can vote for each question or answer only once, but you can change your vote.

Answers with a higher score appear above answers with a lower score when viewing a question. A pinned answer appears above other answers regardless of votes.

**Note:** You cannot vote for your own questions or answers.

1. Navigate to **Self-Service > Knowledge**.
2. Select a question.
3. Click the up or down arrow next to the question or answer you want to vote on.
   The score for that question or answer changes depending on your vote.

You can change your vote by clicking the other arrow.

**Subscribe to a question**

You are automatically subscribed to any question you ask, so you receive notifications when another user votes on, comments on, or answers the question. If you want to receive notifications for a question asked by another use, you can manually subscribe to the question.

Role required: None

You automatically subscribe to any question you ask.

1. Navigate to **Self-Service > Knowledge**.
2. Select a question.
3. Click the subscribe icon

If you want later to stop receiving notifications about this question, click the unsubscribe icon

**Delete a question, answer, or comment**

You can delete questions, answers, or comments that you submitted.

You can delete only questions, answers, and comments you submitted. Knowledge managers can delete any question, answer, or comment within knowledge bases they manage.

Role required: none

1. Navigate to **Self-Service > Knowledge**.
2. Select a question or answer.
3. Within the question, answer, or comment you want to delete, click the **Delete** link.
   Deleting a question also deletes all answers and comments associated with that question. Deleting an answer also deletes all comments associated with that answer.

**Share a question**

You can generate a URL directly to a question and related answers.

Role required: None

1. Navigate to **Self-Service > Knowledge**.
2. Select the question that you want to share.
3. Click **Share**.
   Some browsers do not allow adding content directly to the clipboard. You may need to manually copy the URL from the popup that appears.

Distribute the URL to share the question.

**Social Q&A internationalization support**

The Social Q&A questions and answers are automatically associated with the language that is set for the interface.

You can only browse and search for questions in the language currently set for the interface. For example, if a Social Q&A user has set French as the interface language, any questions that the user asks is associated with the French language. All Social Q&A users who want to view those questions must have their interface language set to French.

**Note:** For Social Q&A internationalization to take effect, you must clear the platform cache and browser cache after selecting the desired language.

**Social Q&A search**

Users can search for specific questions from the knowledge homepage.

Social Q&A uses knowledge search to provide search results. Searching knowledge returns questions that contain the search terms in the question title or the question details, or in the accepted answer.

By default, knowledge search results include both knowledge articles and questions. You can filter results using knowledge search controls, such as filtering by knowledge base or author.

Social Q&A results also appear with knowledge articles when using global search.

Social Q&A uses the Contextual Search feature to generate search results. Questions appear in Contextual Search results, such as when creating an incident. The Social QA Question Search Context and Social QA Question Searcher records define the Social Q&A search. To ensure Social Q&A search functions as intended, do not modify these records.

**Social Q&A tags**

Tags organize questions and provide information about the question subject matter.

Social Q&A shares available tags with other applications allowing you to organize records consistently across the instance. Tags are stored on the Tags [label] table.

You can view a list of tags and filter by tag from the knowledge homepage. Clicking on a tag displays a list of knowledge articles and questions with that tag.
Only users who can edit a question can edit the associated tags. By default, only the question owner and knowledge managers can add or remove tags on questions.

Legacy: Chat

Chat is deprecated in the Istanbul release.

Note: The Connect feature provides an updated instant messaging platform, which is activated by default for new instances. The legacy chat and Connect features should not be used concurrently. There is no migration path from legacy chat to Connect.

Chat provides real-time communication via instant messaging between users in a ServiceNow instance. Features include:

- One-to-one chats (instant messaging) between users.
- Chat rooms for conversations with multiple users. Chat rooms may be public (any user can join) or private (only invited users can join).
- Chat rooms linked to task records. Users can work together to solve issues, and conversation history can be shared by everyone who needs to reference it.
- Help desk chat. End users can access live support via instant messaging. Service desk staff can resolve basic issues in real-time or create incidents directly from chat requests for more extensive issues.
Chat Desktop

Legacy: Get started with Chat

Get started with legacy chat.

Role required: admin

1. Establish use guidelines. Social media can improve communication and aid productivity. To get the most out of these tools, establish clear and simple social media guidelines that foster information sharing and a comfortable work environment.

2. Activate the Chat plugin to enable the legacy chat and legacy Help Desk Chat features.
Configure security settings. Users must log in to use the legacy chat features in the base system. The standard system security settings and Social IT-specific security settings are available. To learn more about setting up these features, refer to the plugin activation pages.

- Chat rooms may be Public (any user can join) or Private (only invited users can join).
- Administrators can limit who can read chat messages on tasks and who can create chat rooms.

Legacy: Installed with Chat

What components are installed with legacy chat.

Demo data is available for legacy chat. The demo data creates a chat queue called Help Desk Chat that is supported by the assignment group Chat Support. Additionally, the Help Desk Chat link is added to the header of the Employee Self-Service portal. To learn more, see Set Up Chat Queues for Help Desk Chat.

Other:

- Event: A new event called `chat.invite` is registered to trigger an email notification when users are invited into a chat room.
- Email Notification: An email notification called Chat Room Invite is added to send when users are invited to a chat room.

Legacy: Fields installed with legacy chat

Legacy chat adds fields.

<table>
<thead>
<tr>
<th>Display name [Table name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header [content_block_header]</td>
<td>Adds the Help Desk Chat link to the ESS portal page.</td>
</tr>
</tbody>
</table>

Legacy: Properties installed with legacy chat

Legacy chat adds properties.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| `glide.chat.invite_fields` | Comma-separated list of fields used to generate the invites when creating a chat room from a task. The user is presented with check boxes for each of the specified fields to select the invites for the chat room. The fields should be references or glide_lists of `sys_user` or `sys_user_group`.

  - **Type:** string
  - **Default value:** `assignment_group,watch_list`
  - **Location:** Social IT > Chat Administration > Properties |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.chat.show_emoticons</td>
<td>Setting that determines whether to display emoticons in conversations.</td>
</tr>
</tbody>
</table>
|                                                 | • **Type**: true | false  
|                                                 | • **Default value**: true  
|                                                 | • **Location**: Social IT > Chat Administration > Properties  |
| glide.chat.sound.message_received.mp3           | Sound played when a message is received in chat (mp3).                                                                                       |
|                                                 | • **Type**: string  
|                                                 | • **Default value**: media/rcvmsg.mp3x  
|                                                 | • **Location**: Social IT > Chat Administration > Properties  |
| glide.chat.sound.message_received.ogg            | Sound played when a message is received in chat (ogg).                                                                                       |
|                                                 | • **Type**: string  
|                                                 | • **Default value**: media/rcvmsg.oggx  
|                                                 | • **Location**: Social IT > Chat Administration > Properties  |
| glide.chat.sound.queue_beep.mp3                 | Sound played when a new user enters the chat queue (mp3). Both this property and glide.chat.sound.queue_beep.ogg must be defined for either property to work. |
|                                                 | • **Type**: string  
|                                                 | • **Default value**: media/button_toggle_on.mp3x  
|                                                 | • **Location**: Social IT > Chat Administration > Properties  |
| glide.chat.sound.queue_beep.ogg                 | Sound played when a new user enters the chat queue (ogg).                                                                                     |
|                                                 | • **Type**: string  
|                                                 | • **Default value**: media/button_toggle_on.oggx  
|                                                 | • **Location**: Social IT > Chat Administration > Properties  |
| glide.chat_room.create_roles                    | Comma-separated list of roles that are allowed to create chat rooms.                                                                            |
|                                                 | • **Type**: string  
|                                                 | • **Default value**: itil  
|                                                 | • **Location**: Social IT > Chat Administration > Properties  |
### glide.short_poll_delay

Short polling delay for XMPP requests. Enter a value in milliseconds. The minimum value is 250. With short polling, the browser sends a request to the server in fixed intervals defined by the property. To minimize performance impact, it is recommended that this value is set greater than or equal to the default value.

- **Type**: integer
- **Default value**: 1000 (one second)
- **Location**: Social IT > Chat Administration > Properties

### Legacy: Script includes installed with legacy chat

Legacy chat adds script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ChatUtils</td>
<td>Provides utilities for chat conversations.</td>
</tr>
</tbody>
</table>

### Legacy: Tables installed with legacy chat

Legacy chat adds tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat Actions [chat_actions]</td>
<td>Defines additional chat window menu items. Access at Social IT &gt; Chat Administration &gt; Actions (administrator and chat_admin).</td>
</tr>
<tr>
<td>Chat Channel [chat_channel]</td>
<td>Stores chat channels, which are chats between members. This table is extended by Chat thread [chat_thread] (a one-to-one chat) and chat_room (a multi-user chat). Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Chat Channel Member [chat_channel_member]</td>
<td>Relationship table that associates channels and members. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Chat Message [chat_message]</td>
<td>Stores instant messages sent from any chat window. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Chat Presence [chat_presence]</td>
<td>Stores presence (status) information for a user. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Chat Queue [chat_queue]</td>
<td>Stores the groups and schedules for providing support via instant message. Defined at Social IT &gt; Chat Administration &gt; Queues (administrator and chat_admin).</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chat Queue Entry [chat_queue_entry]</td>
<td>Stores user requests for live support. Extends Task [task]. On a chat queue record, the Chat queue entries related list displays the entries that are associated with that chat queue. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Chat Room [chat_room]</td>
<td>Stores chat rooms (multi-user chat). Extends Chat channel [chat_channel]. Can be modified if necessary (such as to change a chat room from public to private), but should almost always be managed by system functionality.</td>
</tr>
<tr>
<td>Chat Roster [chat_roster]</td>
<td>Maintains users that are associated with a user’s My Friends list. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Chat Roster Member [chat_roster_member]</td>
<td>Tracks users that are members of a chat room. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Chat Thread [chat_thread]</td>
<td>Stores one-to-one chats. Extends Chat channel [chat_channel]. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Live Headline [live_headline]</td>
<td>Sends system messages. For example, the system may send a message when a user enters or leaves a chat room. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Live Poll Message [sys_live_message]</td>
<td>System table that stores and manages chat messages. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Live User [sys_live_user]</td>
<td>System table that stores and maintains chat users. Extending or modifying data in this table is not recommended.</td>
</tr>
<tr>
<td>Stores the last live sequence number [sys_live_last_sequence]</td>
<td>Stores the last sequence ID. Extending or modifying data in this table is not recommended.</td>
</tr>
</tbody>
</table>

**Legacy: Business rules installed with legacy chat**

Legacy chat adds business rules.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat Queue [Task.active] Updater</td>
<td>Chat Queue Entry [chat_queue_entry]</td>
<td>Sets the chat queue entry Action field to Waiting when the action changes.</td>
</tr>
<tr>
<td>SNC - Chat Queue Average Wait Time</td>
<td>Chat Queue Entry [chat_queue_entry]</td>
<td>When a chat queue entry is accepted, calculates the average wait time for the queue by averaging the last 20 chat queue entries.</td>
</tr>
</tbody>
</table>
Legacy: Chat use

Legacy chat allows you to interact and collaborate through real-time instant messages with other users in an instance.

Use legacy chat to:

- Initiate or participate in chat conversations with one or multiple users.
- Initiate or participate in chat conversations that are attached to task records (such as an incident).
- See when other users are available to chat.

To open the chat desktop, navigate to Social IT > Chat.

Note: Service desk staff may also provide live support to other users via help desk chat.
### Legacy: Update your profile

Your profile identifies your contributions to legacy chat conversations.

Your profile identifies your contributions to conversations. It is created automatically the first time you use chat and consists of:

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>From your user account in ServiceNow. Your name appears on your messages and in the member list of any chat room you join.</td>
</tr>
<tr>
<td>Picture</td>
<td>Select any picture. Your picture appears beside your name in other users’ favorites list and at the top of your favorites list.</td>
</tr>
</tbody>
</table>

To update your profile picture:

1. Click your picture in the top of the favorites list.
2. Browse to the desired picture file and click **Open**.

**Note:** Changes to your profile picture affect legacy chat and live feed if the Live Feed plugin is activated.

---

### Legacy: Update your status

In legacy chat, your status lets other users know whether you are available to chat.
Your status lets other users know whether you are available to chat. Your current status is indicated by the color of the icon in the upper right of your favorites list, beside your name. View the status of other users in your favorites list.

To change your status:

1. Click the status icon beside your name.
2. Select a status (see table).

### Change status

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
<th>Appears to others</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online</td>
<td>Indicates that you are available to chat.</td>
<td>Green icon:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Beth Anglin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chat available</td>
</tr>
<tr>
<td>Away</td>
<td>Indicates that you are not available because you are away.</td>
<td>Red icon:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Beth Anglin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Away</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chat away msg</td>
</tr>
<tr>
<td>Away with a message</td>
<td>Indicates that you are not available and gives a reason:</td>
<td>Red icon and message:</td>
</tr>
<tr>
<td></td>
<td>• In a meeting</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• On the phone</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Out to lunch</td>
<td></td>
</tr>
<tr>
<td></td>
<td>You cannot create a custom message from the chat desktop.</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
<th>Appears to others</th>
</tr>
</thead>
</table>
| Invisible | Indicates that you are not available. You can send and receive messages when your status is Invisible. You appear as Offline to other users. | Black icon: [Beth Anglin](#)  
Chat offline |
| Offline | Indicates that you are not available. You cannot send or receive messages when your status is Offline. Users that are not logged in appear as Offline. | Black icon: [Beth Anglin](#)  
Chat offline |

Legacy: Use your favorites list

In legacy chat, your favorites list appears on your chat desktop and provides certain functions.
Favorites list

- **Users:**
  - Add another user in the system to your favorites list.
  - See if your favorite users are available to chat. Users are organized alphabetically and in sections by status.
  - Start a conversation by double-clicking a name.
  - Expand or collapse a section by clicking **Online** or **Offline**.

- **Rooms:**
  - See the list of your favorite chat rooms.
  - Join a chat room by double-clicking its name.

- **Favorites list toolbar:**
  - Options (  
        ![Chat window menu](image)
  
  Chat window menu

  ): access a menu with options to add a favorite user, view online users, create a chat room, and view chat rooms.
  - Add User (  
        ![Add friend](image)
  
  Add friend

  ): add a favorite user.
  - Create Room (  
        ![Add room](image)
  
  Add room

  ): create a chat room.
  - Invitations (  
        ![Chat invitation](image)
  
  Chat invitation

  ): respond to invitations to join chat rooms.

To expand or collapse a section in the favorites list, click the section header or click the arrows (  on the section header.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Legacy: Add a favorite user

How to add a user to your favorite users list in legacy chat.

1. Click the Add User button.

2. Begin typing a user name and select a user from the list, or click the reference lookup and select a user from the table.

3. Click OK.

Legacy: Remove a favorite user

How to remove a favorite user in legacy chat.

To remove a user from your favorite users list, right-click the user's name and select Remove From List.

Legacy: View an online user

How to view a list of all users who are available to chat (status of Online) in legacy chat.

1. Right-click the Users section header or click Options on the toolbar.
2. Select **Show Online Users**.
   - Start a one-to-one chat with a user on the list by double-clicking a name.
   - **Send Message** or **Add To Friend List** by right-clicking a name.

   ![Online Users](image)

   Online users

**Legacy: View a room**

How to view a list of all public chat rooms in legacy chat.

1. Right-click the **Rooms** section header or click **Options** on the toolbar.

   ![Chat window menu](image)
2. Select **Public Rooms**.
   - To join a room, double-click a name or right-click and select **Join Room**. See **Joining Chat Rooms**.

   ![Public Rooms](image)

   **Legacy: Start a one-to-one chat**

   How to start a one-to-one chat in legacy chat.
   - To start a chat with one user in your favorites list, double-click the user's name or right-click and select **Send Message**.
   - To start a chat with one available user, double-click the user's name on the online users list. See **Viewing Online Users**.
     
     **Send a message** to start a conversation.

   **Legacy: Create a chat room**

   How to start a chat with multiple users from the legacy chat desktop.
   
   To start a chat with multiple users from the chat desktop (requires access rights):
   1. Click **Create Room** on the favorites list toolbar.

   ![Add room](image)

   2. Enter the room details (see table).
3. Click **Create Room**. An invitation appears in the favorites list of all invited users and a new chat window opens on your chat desktop.
Chat task create

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room name</td>
<td>Enter a name to appear on the chat window header or click the <strong>Generate a unique room name</strong> button (Room name generator) to use a system-generated name. The default name for a room created from a task is Chat Room for &lt;Task Number&gt;.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a room description that appears under the name in the rooms list. The default description for a room created from a task is &lt;Short Description&gt;.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter a password, if desired. If a password is specified, only users with the password can join the chat room.</td>
</tr>
<tr>
<td>Room avatar</td>
<td>Upload an image that appears beside the room name in the list of rooms. Click the picture and browse to the desired image file.</td>
</tr>
<tr>
<td>Features</td>
<td>Select all applicable check boxes:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Public</strong> if all users can see the room in the rooms lists.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Members Only</strong> if only invited users can join the room.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Temporary</strong> if the room is not saved once all participants have left. This feature is not available for rooms created from tasks; task chat rooms are always available on the task record.</td>
</tr>
<tr>
<td>Invite</td>
<td>Add invited users by using the <a href="#">glide list</a>. For a room created from a task, you can also select all applicable check boxes:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Assignment group</strong>: invite all users in the assignment group for the task.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Watch list</strong>: invite all users on the watch list for the task.</td>
</tr>
</tbody>
</table>

**Legacy: Create a chat room for a task**

How to start a legacy chat with multiple users from a task record.
Note: This procedure is not possible if the Connect feature is enabled.

1. Open the record (example, an incident on which you are working).

2. Click the Create or Join Chat Room related link.

3. If a chat room already exists, click a name to join the existing chat room. If no chat room exists, continue to the next step to create a new room.

4. Click the create link at the bottom of the window.

5. Enter the room details as you would for a chat room.

6. Click Create Room. An email notification is sent and appears in the favorites list for all invited users (the assignment group and the watch list, if selected, and additional invited users).
7. In the **New Room Created** message, click **Join Room**.
   - A new chat window opens on your chat desktop.
   - All invited users are listed in the chat member list. Invited users that are not currently participating in the chat are listed in gray.

**Legacy: Join one-to-one chats**

In legacy chat, when another user starts a chat by sending a message to you, a chat window opens on your chat desktop. To join the chat, click the window.

**Legacy: Join a chat room**

How to join a chat room in legacy chat.

1. If another user invites you to join a chat room, an invitation appears in your favorites list.

   ![Chat invitation](image)

   **Chat invitation**

2. To respond, click the invitation.

   A window opens that displays the room name, room description, and the name of the user who invited you.
   - To join the chat, click **Join**. When the chat window opens on your chat desktop, click the window.
   - To ignore the invitation, click **Decline**.

![Chat Room for INC00000003 - Wireless access not available on floor 3](image)

**View invitations**

To rejoin a favorite chat room that you have left, click the chat room name in the Rooms section of the favorites list.

To join a public chat room without an invitation, right-click the Rooms section header and select **Public Rooms**. Double-click a room name on the list.
Legacy: Join a chat room for a task

In legacy chat, if another user invites you to join a chat room from a task record, you receive an email notification.

1. Click the link in the email notification.
2. If a prompt for a password appears, enter the password listed in the email notification.
3. When the chat window opens on your chat desktop, click the window.

Legacy: Join a chat room from a task record without an invitation

How to join a chat room in legacy chat without an invitation.

Note: This procedure is not possible if the Connect feature is enabled.

1. Open the task record.
2. Click the Create or Join Chat Room related link.
3. Click a chat room name.
4. If a prompt for a password appears, contact the person who created the chat room for the password.
   - If a chat room has a password, only users with the password can join the chat.
5. When the chat window opens on your chat desktop, click the window.

Legacy: Chat windows

In legacy chat, a chat window appears on your chat desktop for each chat conversation that you start or join.
Legacy: Send messages in legacy chat

How to send messages in legacy chat.

To chat with other users that have joined the conversation, enter your message in the text field at the bottom of the window and press Enter. The message appears in the other users' chat windows.

To send a link, type the full URL (example, http://www.service-now.com). When the message is sent, the text appears blue and any user in the conversation can click it to follow the link.

To send a smiley face, type a colon followed by a close parentheses (:)]. When the message is sent, a smiley face 😊 appears in place of the text. For more emoticons, see Sending Emoticons in Messages (Smileys).

Chat activity is indicated with the following alerts:

- When a new message is posted to an inactive browser tab, the tab name blinks.
- When a new message is posted to an inactive chat window, the window header appears in yellow and blinks.
• When a user joins or leaves a room, a message appears in the other room members’ chat windows.

**Legacy: Send emoticons in legacy chat messages (smileys)**

How to send emoticons (smileys) in legacy chat.

To send an emoticon (smiley), type text from the following table. When your message is sent, the emoticon appears in place of the text. For example, enter colon followed by a close parentheses (:) and a smiley face (😊) appears in your message.

<table>
<thead>
<tr>
<th>Text</th>
<th>Image</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>:) :-)</td>
<td>🧙</td>
<td>Smiley</td>
</tr>
<tr>
<td>B) B-) BD B-D</td>
<td>🕶</td>
<td>Shades</td>
</tr>
<tr>
<td>:D :-D</td>
<td>😊</td>
<td>Big smile</td>
</tr>
<tr>
<td>;° ;°*</td>
<td>😻</td>
<td>Kiss</td>
</tr>
<tr>
<td>:( :-(</td>
<td>😞</td>
<td>Frown</td>
</tr>
<tr>
<td>&lt;3</td>
<td>💟</td>
<td>Heart</td>
</tr>
<tr>
<td>:) ;:-)</td>
<td>😃</td>
<td>Wink</td>
</tr>
<tr>
<td>Text</td>
<td>Image</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>:P ::P</td>
<td>😝</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Playful</td>
<td></td>
</tr>
<tr>
<td>:O ::O</td>
<td>😲</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Surprise</td>
<td></td>
</tr>
<tr>
<td>X( X-{</td>
<td>😞</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Angry</td>
<td></td>
</tr>
<tr>
<td>;): ;&gt;:</td>
<td>😍</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Blush</td>
<td></td>
</tr>
<tr>
<td>;( ;-(</td>
<td>😢</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Crying</td>
<td></td>
</tr>
<tr>
<td>(A)</td>
<td>😇</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Halo</td>
<td></td>
</tr>
<tr>
<td>:? ::?</td>
<td>😐</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Undecided</td>
<td></td>
</tr>
</tbody>
</table>

**Legacy: Change the display**

How to change the display of legacy chat.

To view the chat window menu, click the gear button (ṣ)

Chat window menu

) in the bottom left.

- To show or hide timestamps, select **Show Timestamps** from the chat window menu or press **F2**.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
To show or hide the chat member list, select **Show Members** from the chat window menu or press **F4**.

To resize the window, point to the lower corner (left or right). When the pointer changes shape, drag the window to the desired size.

To move the window, point to the header. When the pointer changes shape, drag the window anywhere on your chat desktop.

To close a chat window, click the **X** in the upper right corner.

**Legacy: Invite a user into a chat**

How to invite another user into a chat in legacy chat.

1. Select **Invite User** from the chat window menu.

2. Begin typing a user name and select a user from the list, or click the reference lookup and select a user from the table.

3. Click **OK**.

   An invitation is sent to the selected user. One-to-one chats are automatically converted into temporary chat rooms.

**Legacy: Add a favorite room**

How to add a favorite room in legacy chat.

To add a room to your favorites, click the chat window and select **Add To Favorites** from the chat window menu.

**Legacy: Remove a favorite room**

How to remove a favorite room in legacy chat.

To remove a room from your favorites, right-click the room name and select **Remove From List**.

**Legacy: Set your chat preferences**

Use the Chat Window Preferences to set audio notifications and default chat window display options in legacy chat.

Use the **Chat Window Preferences** to set audio notifications and default chat window display options. The default display options control how a chat window looks when you first open it. You can still control the display options for an individual window as described in **Changing the Display**.
To view your chat preferences, click your name in the upper left corner of the chat desktop and select **Chat Preferences**.

![Chat preferences](image)

To set your preferences, select or clear the check boxes next to the options, then click **Update**.

<table>
<thead>
<tr>
<th>Preferences</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Turn audio notifications on or off.</td>
</tr>
<tr>
<td>Conversation Windows</td>
<td>Set default options for showing timestamps and members in one-to-one chats.</td>
</tr>
<tr>
<td>Group Chat Windows</td>
<td>Set default options for showing timestamps members in chat rooms.</td>
</tr>
</tbody>
</table>

**Legacy: Delete a chat room**

You can delete chat rooms in legacy chat.

Role required: chat_admin

Note that when you delete a chat room, the system also deletes the records for any chat members and messages.

1. In the application navigator filter, enter `chat_room.list`.
2. Delete multiple chat rooms from the list or open a chat room record and click **Delete**.

**Legacy chat administration**

Users with the chat_admin role can administer various aspects of legacy chat.
Define chat room access rights

Control the access rights for creating a chat room so that not all users can create a chat room.

Role required: chat_admin

To define the access rights for creating chat rooms:

1. Navigate to Social IT > Chat Administration > Properties.
2. Locate the property Comma-separated list of roles that are allowed to create chat rooms.
3. Enter user roles. A user must have one of the specified roles to create a chat room.

Change chat room message read access

In legacy chat, you can associate a chat room with a record, such as an incident, and add the chat messages to a Chat Activity journal field on the form.

Role required: admin

By default, a user can read the chat messages for a room if either of the following is true:

- The room is public
- The user is a member of the room

To change chat room message read access:

- Modify the Chat message access control rule or create a new rule.
- Read access to the messages displayed is handled by the access control list security operation chat_messages_read on the Chat room [chat_room] table.

View a legacy chat message as a journal field

You can view all chat messages in one place by viewing them as a journal field.

Chat rooms can be linked to any task record in the following ways:

- Create a room from the record.
- Create a record from a chat room, such as creating an incident from a Help Desk Chat.

To view the chat messages as a journal field:

- Configure the task record form to select the Chat Activity field.
- The maximum number of chat messages that are displayed by this field is 1000.
Chat Activity

Chat actions

Chat actions are additional items that appear in the chat window menu (requires the Chat plugin). Administrators and users with the chat_admin role can define chat actions.
Add actions to the legacy chat window menu

You can create new actions and add them to the chat window menu.

1. Navigate to **Social IT > Chat Administration > Actions**.
2. Select an action to edit or click **New**.
3. Enter the chat action details and click **Update** or **Submit**.

The following example demonstrates how to add a chat action that appears only on windows where the user is a Help Desk Agent. The action appears on the menu as **Show User Type** and opens a popup window that indicates a current user of queue_agent.

- **Action Name**: Show User Type
- **Active**: Select the check box.
- **Order**: 100
- **Client Show Condition**:
  ```javascript
  answer = g_chat.getChatType() == 'queue_agent';
  ```
- **OnClick Action Script**:
  ```javascript
  alert('The current user is: ' + g_chat.getChatType());
  ```
Chat action details

You can define a chat action name and the script that runs when the action is selected.

Chat action details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Name</td>
<td>Enter a label for the action as it appears in the menu.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to activate or clear the check box to deactivate the action. Only active actions may appear in the menu.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter the order in which the action appears in the menu. Standard menu items (such as Show Timestamps) always appear at the top of the chat menu, followed by chat actions in order.</td>
</tr>
<tr>
<td>Client Show Condition</td>
<td>Define the conditions under which this menu option appears. The show condition must set the pre-defined answer variable to a boolean value.</td>
</tr>
<tr>
<td>OnClick Action Script</td>
<td>Enter the JavaScript code that runs when the menu item is selected.</td>
</tr>
</tbody>
</table>

Available methods associated with the g_chat variable

The g_chat variable is a legacy chat window object that is available in the Client Show Condition and OnClick Action Script of a chat action definition.

Method Summary

The following table defines the available methods associated with this object.

<table>
<thead>
<tr>
<th>Return Object</th>
<th>Details</th>
</tr>
</thead>
</table>
| Array         | getActiveUsers()  
|               | Returns the active users.  
|               | Returns:  
|               | Array - Returns the active users. |
| String        | getChannelJID()  
|               | Returns the channel JID, which is a sys_id for a record chat_channel table.  
|               | Returns:  
<p>|               | String - Returns the channel JID. |</p>
<table>
<thead>
<tr>
<th>Return Object</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>getChatType()</td>
</tr>
<tr>
<td></td>
<td>Determines the chat window type.</td>
</tr>
<tr>
<td></td>
<td>Returns:</td>
</tr>
<tr>
<td></td>
<td>String - Returns one of the following values that specifies the type of user:</td>
</tr>
<tr>
<td></td>
<td>• queue_agent: Help Desk Chat support agent</td>
</tr>
<tr>
<td></td>
<td>• queue_user: Help Desk Chat end user</td>
</tr>
<tr>
<td></td>
<td>• group_chat: The individual is a member of a chat room (multiple users)</td>
</tr>
<tr>
<td></td>
<td>• conversation: The individual is a member in a private chat with another user</td>
</tr>
<tr>
<td>String</td>
<td>getChatQueueAgent()</td>
</tr>
<tr>
<td></td>
<td>Returns the <code>sys_id</code> for agent that is administering this thread.</td>
</tr>
<tr>
<td></td>
<td>Returns:</td>
</tr>
<tr>
<td></td>
<td>String - Returns the <code>sys_id</code> of the chat queue agent.</td>
</tr>
<tr>
<td>String</td>
<td>getChatQueueUser()</td>
</tr>
<tr>
<td></td>
<td>Returns the <code>sys_id</code> for end user of the chat queue.</td>
</tr>
<tr>
<td></td>
<td>Returns:</td>
</tr>
<tr>
<td></td>
<td>String - Returns the <code>sys_id</code> of the chat queue user.</td>
</tr>
<tr>
<td>String</td>
<td>getThreadID()</td>
</tr>
<tr>
<td></td>
<td>Returns the thread ID. This returns the same value as <code>g_chat.getChannelJID().getID()</code></td>
</tr>
<tr>
<td></td>
<td>Returns:</td>
</tr>
<tr>
<td></td>
<td>String - Returns the thread ID.</td>
</tr>
</tbody>
</table>

**Legacy: Help desk chat**

Communicate with service desk staff using instant messaging.

**Note:** The Connect Support feature provides an updated messaging platform similar to help desk chat. The help desk chat and Connect Support features should not be used concurrently. There is no migration path from help desk chat to Connect Support.

Users can communicate directly with service desk staff using instant messaging in a ServiceNow instance (requires the Chat plugin.)

- Users access live support from the Employee Self-Service portal.
- Service desk staff provide support from the chat desktop.

**Legacy: Use help desk chat to get support**

You can contact service desk staff.

2. Log in to your ServiceNow account. Only logged in users can use chat.
3. In the upper right, click the **Service Desk Chat** button. A chat window opens.
4. Enter your question in the text field at the bottom of the window and press **Enter**.
   a. A message confirms that you have entered the chat queue and indicates your position and estimated wait time.
   b. When a service desk staff member accepts your chat and begins working on your question, another message appears.
5. Chat with your service desk agent via instant messaging.
   Service desk staff may lead you through troubleshooting, ask clarifying questions, or create an incident record to address your question.

**Note:** Administrators can configure Service Desk Chat to be accessible on content management (CMS) pages.

**Service Desk Chat Window**

**Legacy: Use help desk chat to provide support**

Staff who are assigned to chat support can provide live support via instant messaging. Administrators and users with the chat_admin role can assign chat support staff (see Set Up Chat Queues for Help Desk Chat).
To provide users with live support using chat:

1. Navigate to **Social IT > Chat** to open your chat desktop.
   - A chat queue agent window appears on your chat desktop for each chat queue you are assigned to. If no agent windows appear, ask an administrator to add you as a member of the assignment group for a chat queue.
   - The chat queue agent window displays the number of users in the queue and how long they have been waiting.
   - Every member of the assignment group sees the associated chat queue agent window.

2. Click **Answer Next User** to answer the next user or click **Answer** beside a specific user in the queue. A chat window opens.
   - Only the agent and the user can see the chat window.

Provide support via instant messaging. Chat queue agents can access additional support functions in the chat window menu:

- **Invite User**: invite another expert to assist with a support chat. An invitation appears in the favorites list of an invited user.
- **Create Incident from Chat**: create a new incident record with the initial question as the short description and the support chat as a linked chat room (accessible from the Create or Join Chat Room related link on the Incident form).

**Note**: Administrators can edit this action or add additional actions to the chat window menu.
Chat Queue Agent

Legacy: Set up chat queues for help desk chat

Help desk chat allows users to communicate directly with Service Desk staff via instant messaging in an instance.

Chat queues define the schedules, staff, and system messages for help desk chat. Administrators and users with the chat_admin role can set up chat queues.

Define a chat queue for legacy chat

How to define a chat queue for legacy chat.

Note: The Chat Queue [chat_queue] table is also used by Connect Support. Legacy chat and Connect Support should not be used concurrently.

1. Navigate to Social IT > Chat Administration > Queues.
2. Select a chat queue to edit or click New.
3. Enter the chat queue details and click Update or Submit.

Chat queue details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name that end users see as a title for the queue.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to activate or clear the check box to deactivate the chat queue.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Select the group that contains the support staff for the chat queue. Every agent sees the chat queue on their chat desktop and can answer any user that is waiting in the queue. To assign staff members to the group, see Assign Service Desk Staff to a Chat Queue.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Select a schedule that defines when a queue is available (see Use Schedules). If the queue is always available, clear the field.</td>
</tr>
<tr>
<td>Question</td>
<td>Enter the initial question that end users see when they open a new Help Desk Chat. For example, How can I help you?</td>
</tr>
<tr>
<td>Confirm problem</td>
<td>(Optional) Enter the confirmation message that end users see when they enter an initial question. For example, Thank you for contacting support. Your problem has been submitted and an agent will be with you shortly.</td>
</tr>
<tr>
<td>Initial agent response</td>
<td>(Optional) Enter the message that end users see when an agent accepts their chat. For example, Thank you for waiting. I am looking into your question now and will be with you shortly.</td>
</tr>
<tr>
<td>Not available</td>
<td>Enter the message that end users see when a Help Desk Chat request is not accepted because the queue is outside its scheduled availability (defined by the Schedule field).</td>
</tr>
</tbody>
</table>

**Assign service desk staff to a chat queue**

Chat queue agents are Service Desk staff that are members of a chat queue's assignment group.

To assign agents to a chat queue:

1. Navigate to **User Administration > Groups**.
2. Select an existing assignment group or click **New**.
3. Enter or modify the group details (see **Create a Group**).
4. Right-click the header and select **Save**.
5. In the **Group members** related list, click **Edit**.
6. Using the slushbucket, add support staff to the group.
7. Navigate to **Social IT > Chat Administration > Queues**.
8. Select the chat queue for which the group provides support.
9. In the **Assignment Group** field, select the group.

```
| Group | | Group members (6) |
|-------|-------------------|
| Name: Chat Support | Group email: |
| Manager: David Loo | Parent: |
| Description: Manages the Help Desk Chat Queue by responding to Click to Chat requests in a timely manner |
```

**Chat queue group**

*Make help desk chat accessible to an end user*

Users access live support from the Employee Self-Service Portal (ESS Portal).

Users access live support from the Employee Self-Service Portal (ESS Portal). To make a Help Desk Chat queue accessible to end users, add a link to the ESS Portal (requires the Content Management Plugin).

To change the default link in the ESS header:

1. Navigate to **Content Management > Headers**.
2. Open *Portal - Header*.
3. In the **Chat queue** field, enter the chat queue that users access by clicking the link in the ESS header. Clear the field to remove the chat queue link.
4. Click **Update**.

![ServiceNow](image)

Chat queue link

Add a custom link elsewhere on the ESS portal

How to add a custom help desk chat link on the ESS portal.

1. Navigate to **Content Management > Static HTML**.
2. Click **New**.
3. Enter a **Name**.
4. In the **Static content** field, click **Toggle HTML Source** to edit the field in HTML source mode.

5. Create a link to the desired Help Desk Chat queue (see **Link Syntax**).
6. Click **Submit**.
7. Add the new content block to the desired location on the portal (see **Adding Content to the Page**).

Link syntax

To open a Help Desk Chat queue from a custom link on the ESS Portal, you must call the `CustomEvent.fire` method using appropriate arguments.

To open a Help Desk Chat queue from a custom link on the ESS Portal, you must call the `CustomEvent.fire` method using appropriate arguments. Details of the API call and an example that generates an anchor link are provided below.

**API Call:**

```javascript
CustomEvent.fire(LiveEvents.LIVE_EVENT,
    LiveEvents.LIVE_WINDOW_JOIN_QUEUE_QUERY, CHAT_QUEUE_SYS_ID,
    CHAT_QUEUE_SYS_NAME);
```

where the variables are:

- `CHAT_QUEUE_SYS_ID`: Specifies the sys_id for the chat queue.
• **CHAT_QUEUE_SYS_NAME**: Specifies the name of the chat queue (must match the value the Name field of the chat queue record).

Example: This example creates an anchor link that opens the Help Desk Chat queue.

```html
<a href="#" onclick="CustomEvent.fire(LiveEvents.LIVE_EVENT,
LiveEvents.LIVE_WINDOW_JOIN_QUEUE_QUERY,
'c54f0abf0a0b452db84664f409c79c',
'Help Desk Chat'); return false;">
  Help Desk Chat
</a>
```

**Monitor chat queues**

Chat queues can yield useful Key Performance Indicators (KPI) for evaluating support effectiveness.

- **Queue Wait Time**: amount of time a user waits in the queue before a help desk agent accepts the request.
- **Percentage of Chats Abandoned**: users that exit the queue before an agent responds (user stopped waiting).
- **Percentage of Chats Accepted**: requests that are answered by an agent.

**Note**: This information is not calculated automatically. Administrators may calculate these values based on data collected by chat queues.

**Monitor help desk chat tasks**

Help Desk Chat requests are tracked in the Chat queue entries table, which appears as a related list on the associated chat queue record.

Help Desk Chat requests are tracked in the Chat queue entries table, which appears as a related list on the associated chat queue record. Because this table extends the Task table, administrators can take advantage of core task functionality. For example, administrators can attach Service Level Agreements (SLAs) to chat queue entries to evaluate the response time of Help Desk Chat support.

**Legacy Notify**

Legacy Notify enables organizations with a Twilio account to send notifications using text and voice messages.

**Note**: This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see [Notify](#).

Legacy Notify also allows conference calls between ServiceNow users to enable quick communications.

When Legacy Notify is active, you can configure ServiceNow to automatically generate and send notifications to selected contacts, for instance when a new incident communication plan is raised in the incident communications management process.

Users with the notifynow_admin role can set properties and monitor message and conference call activities.

Legacy Notify has been implemented for use within Incident Communications Management. Refer to the Notify API documentation for details on how to implement Legacy Notify for use within other ServiceNow applications.
Working with Legacy Notify

Follow this process to enable and use Notify.

This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

1. Set up a Twilio account to provide phone connectivity for Notify.
2. Activate Notify.
3. Configure Notify to use Twilio.
4. Begin using Notify immediately within Incident Communications Management.
5. Use the Notify API with other ServiceNow applications to provide SMS, voicemail, email, and conference calls for those applications.

View a Legacy Notify question

Questions contain a response action and a set of response choices. Use these questions to simplify communications. Then, you can monitor the resulting communication thread.

Role required: notifynow_admin

This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

For example, the process can be used to ask members of a specific on-call group to acknowledge or reject an incident. Depending on the answer from the first team member, the incident is assigned to that person or an SMS question is sent to the next on-call member. In this example, the questions are used as part of a workflow.

To see a list of predefined questions both Notify and On-Call Scheduling need to be active.

1. Navigate to Notify > Questions.
2. Click the question **On-Call responsibility Accept/Reject** to see the question details.

![Notify Question - On-Call responsibility Accept/Reject](image)

![Notify Response Choices](image)

3. Click the **Notify Response Choices** related list to view or edit the choices. The person who receives the SMS question can either choose to accept or reject the assignment. If the assignment is accepted, the **Response action** can be that the incident is actually assigned to that person. The response action is a script that you can modify or replace. If the assignment is rejected, an SMS question may be sent to the next person in the escalation chain, and so on. You can combine questions with a workflow to automate a process like on-call scheduling escalation.

**Create a question in Legacy Notify**

Define a question that can be sent to users.

**Role required:** notifynow_admin

This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

1. **Navigate to Notify > Questions.**
2. **Click New.**
3. Fill in the fields, as appropriate.

### Notify New Question form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a description of the question.</td>
</tr>
<tr>
<td>Question</td>
<td>Enter the question you want to send. You can enter variables in the question with the <code>{}</code> tags, for example, <code>{0}</code>. When using more than one variable, use consecutive numbering. When using multiple variables, reference them by specifying their position in the parameter list, starting from <code>{0}</code>. The variable is picked up by the script and translated into, for example, an incident or a problem number.</td>
</tr>
<tr>
<td>Params</td>
<td>Enter parameters which map to the fields on the record that the workflow was triggered for. This enables the message to show dynamic data. Multiple parameters should be separated by a comma. For example, number, shows the incident number in case the workflow was triggered from an incident. A second parameter could be, for example short_description.</td>
</tr>
<tr>
<td>Response Action</td>
<td>Select the action that must be taken. This is a script that can be modified, or you can create a new script by clicking the search button and selecting New. Several examples of scripts are shown. Write your own script and click Submit.</td>
</tr>
</tbody>
</table>

4. Click Submit.

### Create a new response choice in Legacy Notify

Create a new response choice to allow users to select that response for a Notify question.

Role required: notifynow_admin

This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

1. Navigate to Notify > Questions.
2. Open the notify question you have just created.
3. Click New to create a new notify response choice.
4. Fill in the fields, as appropriate.

### Notify New Response Choice form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>The abbreviation for the response choice in the text message. For example, ACC for accept or REJ for reject.</td>
</tr>
<tr>
<td>Text</td>
<td>The text displayed for this response choice.</td>
</tr>
</tbody>
</table>
### View Legacy Notify messages

Applications implementing Notify, such as Incident Communications Management, can send Short Message Service (SMS) text messages to relevant contacts under predefined conditions, such as when a new incident communication plan has been created.

Role required: notifynow_admin

This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

1. Navigate to Notify > Messages.
2. Click a message to see the message details.

![SMS Outbox](image)

### SMS Outbox Details

#### View Legacy Notify conversations

The Notify Conversation [notifynow_conversation] table tracks bi-directional communications and adds the ability to have more than one active conversation with the same phone number at the same time.

Role required: notifynow_admin

This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

The thread number is combined with the phone number to link the SMS or email response to the correct conversation. Conversations remain active until a response is received or until they are automatically deactivated after the thread release time runs out. The default thread release time is 10 days. To change this value, add the `nn.thread.release.age` property.

1. Navigate to Notify > Conversations.
2. Click a conversation record to see the conversation details.

![Notify Conversation]

Notify Conversation Details

The State of the conversation can have one of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ended</td>
<td>The conversation has been completed.</td>
</tr>
<tr>
<td>Failed</td>
<td>The conversation has failed.</td>
</tr>
<tr>
<td>Pending</td>
<td>The SMS or email is waiting to be sent.</td>
</tr>
<tr>
<td>Sent</td>
<td>The SMS or email has been sent.</td>
</tr>
<tr>
<td>Unanswered</td>
<td>The SMS or email has not been answered.</td>
</tr>
</tbody>
</table>

Note: The mode of conversation cannot be changed during one conversation thread. For example, you cannot switch between SMS and email during one conversation.

View Legacy Notify conference calls

Applications that use Notify, such as Incident Communications Management, can launch and maintain conference calls between involved parties.

Role required: notifynow_admin

This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

1. Navigate to Notify > Conference Calls.

You can also access conference call information from the relevant record, such as the Conference Calls related list in an incident communication plan record.
2. Click a conference call in the list to view details.

![Notify Conference Call]

Notify Conference Call Details

3. Click the arrow beside the check box to expand a Participant entry.
   This shows participant session information, including details of the conference calls that the participant has been involved in.
4. Click a Participant name to see more detailed information about that participant.

 Legacy public conference calls

A Notify conference call can be public.

**Note:** This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

The **Private** field on the conference call record indicates if a call is private (selected) or public (not selected). By default, all calls created automatically, such as those created through Incident Communications Management, are public. You can create private calls using the Notify API initiateConferenceCall method.

When created, public conference calls generate an associated **Code** which is sent via SMS to all invited participants. These participants can distribute the code to allow other users to join the public call. An administrator can control the format of the code using the property glide.notifynow.conference_call.code.pattern. Anyone with the code can connect to a public conference call using one of these methods:

- By calling the Twilio phone number and entering the code for that conference call.
- By sending the code in an SMS message to the Twilio phone number. Participants that join a public call this way are considered ad-hoc participants, indicated on the participant record.

**Administering Legacy Notify**

An administrator can set up Notify, manage Notify properties and conference call participants.
Configuring legacy Notify to use the Twilio service

Each ServiceNow instance using Notify requires a valid Twilio account and telephone number. Refer to the Twilio documentation for detailed instructions.

After the Twilio account is set up, perform the following to use that account with Notify:

• Associate the account with Notify
• Configure Twilio with ServiceNow endpoints

Associate a Twilio account with Legacy Notify

Associate a Twilio account with your instance to use that account for legacy Notify.

Role required: notifynow_admin
This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

1. Navigate to Notify > Administration > Properties.
2. Enter the **AccountSID**, **AuthToken** and **phone number** values. These values can be obtained from the Twilio dashboard:

![Twilio Dashboard](image)

**Twilio Dashboard**

When the Twilio account details are entered in the Notify Properties page, the account status is updated.

3. [Optional] To use Notify on multiple ServiceNow instances, activate Notify on each instance and create a separate Twilio account and telephone number for each instance.

**Note:** Some telephone numbers are voice capable, but not SMS capable. This is shown in the Notify properties with relevant messages. Two methods are available to check this: `isSMSCapable` and `isVoiceCapable`.

**Configuring the Twilio service with endpoints in legacy Notify**

In order for the Twilio service to receive Notify commands, the **Request URL** field value for every Twilio telephone number must point to the ServiceNow instance that uses Notify with that Twilio telephone number.

**Note:** This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

To set these values, do one of the following:

- Define them manually in the Twilio service dashboard.
- Ensure the fields are blank in the Twilio service dashboard, then open the Notify Properties page. Notify automatically configures the correct endpoints if the **Request URL** fields are blank.

Set these values from within the Twilio service dashboard.
**Twilio Numbers Dashboard**

The `notifyusa` values underlined in the image should be replaced with your ServiceNow instance name, for:

- **Voice Request URL**: `https://notifyusa.service-now.com/NotifyNowCallProcessor.do`
• **Status Callback URL:** https://notifyusa.service-now.com/NotifyNowCallStatusProcessor.do

• **Messaging Request URL:** https://notifyusa.service-now.com/NotifyNowSmsProcessor.do

**View and edit legacy Notify properties**

You can view and edit Notify properties.

Role required: notifynow_admin
This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

1. Navigate to Notify > Administration > Properties.

   Notify Properties form

2. Fill in the fields.

   Notify Properties form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Status</td>
<td>Information showing the status of the associated Twilio account.</td>
</tr>
<tr>
<td>Twilio AccountSID</td>
<td>The Twilio account AccountSID, acting as the user name for that account.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Twilio AuthToken | The Twilio account AuthToken, acting as the password for that account. See Associating a Twilio Account.
Twilio SMS and voice enabled phone number | The Twilio number that Notify will use. Telephone numbers must be entered in the E.164 format and need to exist under the Twilio account. See Associating a Twilio Account.
Number of frequent conference call participants to be displayed | The number of people to display in the frequently called list.
Voice | The voice used for Notify communications. Select woman or man to provide female or male voice support for English, Spanish, French, German, and Italian. Select alice to provide female voice support for a wider range of languages.

3. Click **Submit**.

### Legacy Notify account status messages

Account status messages are visible on the Notify Properties page.

#### Account Status Message Descriptions

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your account is ready for use</td>
<td>Notify is correctly configured and ready for use.</td>
</tr>
<tr>
<td>Your Twilio AccountSID or AuthToken are not valid</td>
<td>An incorrect value has been entered in the AccountSID or AuthToken fields in the Notify properties.</td>
</tr>
<tr>
<td>Your Twilio phone number is not valid</td>
<td>Incorrect telephone number information is defined in the Notify properties.</td>
</tr>
<tr>
<td>Your Twilio phone number does not have properly configured endpoints</td>
<td>The Request URL endpoint settings have not been properly configured.</td>
</tr>
<tr>
<td>Your Twilio account is not configured properly</td>
<td>One or more of your Twilio account settings is incorrect. Open the Twilio dashboard and check the settings.</td>
</tr>
</tbody>
</table>

### Manage Legacy Notify conference call participants

As a Notify administrator, you can mute, unmute, and kick participants on a conference call.

**Role required:** notifynow_admin

This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

Muting a participant prevents that person from speaking on the conference call but does not notify any participants, including the muted participant. Kicking a participant removes that person from the conference call and sets the **Response** field for the participant session to kicked.

1. Navigate to **Notify > Conference Calls**.
2. Select an active conference call.
3. In the **Notify Conference Call Participants** related list, select a participant.
4. Click the button for the action you want to perform, such as **Mute** to mute the participant.

You can perform these actions for multiple participants as a single operation using the **Actions on selected rows** choice list on the **Notify Conference Call Participants** related list.

**Installed with Legacy Notify**

Activating the Notify plugin adds or modifies tables, user roles, script includes, and other components.

**Note:** This content applies only to the Legacy Notify application, available prior to the Geneva release. For information about the Notify application available starting with Geneva, see Notify.

**Tables**

Notify adds or modifies the following tables.

<table>
<thead>
<tr>
<th>Display Name [Table Name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answer [notifynow_answer]</td>
<td>Information for possible answers to the SMS question sent.</td>
</tr>
<tr>
<td>Conversation [notifynow_conversation]</td>
<td>Information for the conversation thread.</td>
</tr>
<tr>
<td>NotifyNow Conference Call [notifynow_conference_call]</td>
<td>Information for conference call records.</td>
</tr>
<tr>
<td>NotifyNow Participant Session [notifynow_participant_session]</td>
<td>Information regarding conference call sessions for individual conference call participants.</td>
</tr>
<tr>
<td>Participant [notifynow_participant]</td>
<td>Information regarding individual conference call participants.</td>
</tr>
<tr>
<td>Question [notifynow_question]</td>
<td>Information for the possible questions in the SMS.</td>
</tr>
<tr>
<td>Response_action [notifynow_response_action]</td>
<td>Information for the notify response action associated with the question.</td>
</tr>
<tr>
<td>Response_choice [notifynow_response_choice]</td>
<td>Information for the notify response choice associated with the question.</td>
</tr>
<tr>
<td>SMS Messages [notifynow_message]</td>
<td>Information for the actual SMS messages sent.</td>
</tr>
</tbody>
</table>

**Properties**

Notify adds the following system properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.notifynow.frequent_participant_count</td>
<td>The number of frequent conference call participants to be displayed.</td>
</tr>
</tbody>
</table>
### Property

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.notifynow.voice</td>
<td>The voice used for Notify communications.</td>
</tr>
<tr>
<td>glide.notifynow.twilio.accountsid</td>
<td>The Twilio account AccountSID.</td>
</tr>
<tr>
<td>glide.notifynow.twilio.token</td>
<td>The Twilio account AuthToken.</td>
</tr>
<tr>
<td>glide.notifynow.twilio.phonenumber</td>
<td>The Twilio number that Notify will use.</td>
</tr>
<tr>
<td>glide.notifynow.twilio.answering_machine_detection</td>
<td>A boolean flag to enable or disable answering machine detection. Set to true to use answering machine detection. Set to false to continue the call.</td>
</tr>
<tr>
<td>nn.thread.release.age</td>
<td>The number of days after which the conversation thread release time runs out. Defaults to 10 days.</td>
</tr>
<tr>
<td>glide.notifynow.conference_call.code.pattern</td>
<td>The pattern used to generate a conference call code for public conference calls. Number signs (#) in the pattern are replaced with random numbers when a code is generated.</td>
</tr>
<tr>
<td>glide.notifynow.fix_invalid_phone_number</td>
<td>A boolean flag to enable or disable automatic correction of invalid phone numbers. Twilio might incorrectly prefix non-US phone numbers with 1. When this property is true, the instance automatically removes the 1 for non-US calls. When this property is false, you might be incorrectly identified when reconnecting to a call using SMS.</td>
</tr>
</tbody>
</table>

### User Roles

Notify adds the following user roles.

#### User Roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>notifynow_admin</td>
<td>None</td>
<td>Administrator with privileges for Notify functionality.</td>
</tr>
</tbody>
</table>

### UI Actions

Notify adds the following UI actions.

#### UI Actions

<table>
<thead>
<tr>
<th>UI Action</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate Conference Call</td>
<td>Incident Communication Plan [incident_alert]</td>
<td>Adds a link to the Incident Communication Plan form, if that plugin is activated, which displays a dialog box for starting a conference call with selected participants.</td>
</tr>
</tbody>
</table>
UI Action | Table | Description
---|---|---
Invite to Conference Call | NotifyNow Conference Call [notifynow_conference_call] | Adds a link to the Notify Conference Call form which displays a dialog box for adding more users to an active conference call.

Script Includes

Notify adds the following script includes.

**Script Includes**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IncidentAlertConferenceCall</td>
<td>A utility JavaScript Prototype class allowing users to initiate the conference call and add other users to the conference call. Should be used in conjunction with the slushbucket UI page (notifynow_participant).</td>
</tr>
</tbody>
</table>

Business Rules

Notify adds the following business rules.

**Business Rules**

<table>
<thead>
<tr>
<th>Business Rule Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMS on new Incident Communication Plan</td>
<td>Incident Communication Plan [incident_alert]</td>
<td>Sends an SMS to any default contacts added when an incident communication plan record is created.</td>
</tr>
<tr>
<td>Conference Call Allowed</td>
<td>Incident Communication Plan [incident_alert]</td>
<td>Displays or hides the initiate conference call UI action by storing true or false in g_scratchpad.conferenceCallAllowed.</td>
</tr>
<tr>
<td>Update Conference Call Started IA Activity</td>
<td>NotifyNow Conference Call [notifynow_conference_call]</td>
<td>Logs when a conference call started by writing to an incident communication plan's comment field if the source record is from the incident_alert table.</td>
</tr>
</tbody>
</table>
### Workflow Activities

Notify adds the following workflow activities.

#### Workflow Activities

<table>
<thead>
<tr>
<th>Activity Name</th>
<th>Activity Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Notify SMS</td>
<td>Notify</td>
<td>Sends an SMS message (maximum 1600 Characters) to an E.164 compliant mobile phone number of the selected recipients and/or groups.</td>
</tr>
<tr>
<td>Send Notify SMS Question</td>
<td>Notify</td>
<td>Sends predefined SMS Question message (maximum 1600 Characters) to an E.164 compliant mobile phone number of the selected recipients and/or groups. This is one of two main activities for workflow On-Call Assign by Acknowledgement. In a predefined message, the recipient is asked to assign himself to a newly created incident. The same message also contains predefined answers.</td>
</tr>
<tr>
<td>Send Email Question</td>
<td>Notify</td>
<td>Sends email generated from email template containing notification that recipient is the current On-call resource for a newly created task. This is one of two main activities for the workflow On-Call Assign by Acknowledgement. In a predefined message, the recipient is asked to assign himself to a newly created incident. The email contains two links that enable the user to accept or reject assignment.</td>
</tr>
</tbody>
</table>

### Legacy Notify API - Global

The legacy Notify API provides functionality for sending emails, sending SMS messages, and setting up conference calls.
Use this when you want to use Notify functionality with applications on your system.

Note: This API is included with the legacy Notify functionality. For APIs included in the current Notify feature, see the Notify, NotifyAction, NotifyPhoneNumber, and NotifyClient APIs.

**NotifyNow - getReadyState()**

Indicates whether Notify is set up correctly or not.

This method can only be accessed by administrators or users with the notifynow_admin role. Users with all other roles get the message False when trying to run the function in a script.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>True if Notify is set up correctly, otherwise false.</td>
</tr>
</tbody>
</table>

```javascript
var nn = new SNC.NotifyNow();
gs.log(((nn.getReadyState()) ? "OK" : "NOT OK"));
```

**NotifyNow - getStatus()**

Returns the current status of Notify configuration.

This method can only be accessed by administrators or users with the notifynow_admin role. Users with all other roles get the message Unauthorized when trying to run the function in a script.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>One of the possible status messages.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO_NUMBER_MESSAGE</td>
<td>The account does not have a telephone number set up. Ensure that you set up the telephone number for the account.</td>
</tr>
<tr>
<td>NO_ENDPOINTS_MESSAGE</td>
<td>The account does not have its endpoints set up correctly. Ensure that you set up the endpoints for the account.</td>
</tr>
<tr>
<td>ACCOUNT_OK_MESSAGE</td>
<td>The account is active and ready for use.</td>
</tr>
<tr>
<td>ACCOUNT_NO_AUTH</td>
<td>The Twilio AuthToken is not valid.</td>
</tr>
<tr>
<td>ACCOUNT_NOT_CONFIGURED</td>
<td>Twilio AccountSID or AuthToken is not valid.</td>
</tr>
</tbody>
</table>

```javascript
var nn = new SNC.NotifyNow();
gs.log(nn.getStatus());
```

**NotifyNow - initiateConferenceCall(String[] conferenceCallParticipants, String conferenceCallTitle)**

Initiate a new conference call.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>conferenceCallParticipants</td>
<td>String</td>
<td>One or more users, conference call participants, identified by the sys_ids from the sys_user table or E.164-compliant phone numbers.</td>
</tr>
<tr>
<td>conferenceCallTitle</td>
<td>String</td>
<td>Title of the conference call. This parameter has a maximum length of 40 characters.</td>
</tr>
</tbody>
</table>
This initiates a conference call with E.164-compliant phone numbers for participants, without the optional source record parameter and and does not send any conference call details via SMS or email.

```
var participants = ['+31205655548', '+31205655552', '+31652825393'];
// set up conference call
var nn = new SNC.NotifyNow();
var conferenceCall = nn.initiateConferenceCall(participants, "testing12");
gs.log('started conference call: ' + conferenceCall.getUniqueValue());
```

### NotifyNow - initiateConferenceCall(String[] conferenceCallParticipants, String conferenceCallTitle, GlideRecord sourceRecord, Boolean private)

Initiate a new conference call.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>conferenceCallParticipants</td>
<td>String</td>
<td>One or more users, conference call participants, identified by the sys_ids from the sys_user table or E.164-compliant phone numbers.</td>
</tr>
<tr>
<td>conferenceCallTitle</td>
<td>String</td>
<td>Title of the conference call. This parameter has a maximum length of 40 characters.</td>
</tr>
<tr>
<td>sourceRecord</td>
<td>GlideRecord</td>
<td>Source record to associate to the conference call such as an incident or problem number.</td>
</tr>
<tr>
<td>private</td>
<td>Boolean</td>
<td>Value to control if a conference call is private. This value defaults to false.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlideRecord</td>
<td>The conference call record, or null if there was an error.</td>
</tr>
</tbody>
</table>
This initiates a conference call with participants that have a E.164-compliant phone number and participants from the sys_user table and sends conference call details via SMS and email to all participants.

```javascript
// define phone number participants
var participants = ['+31205655548', '+31205655552', '+31652825393'];

// we also want to add two Dutch sys_user participants
var user = new GlideRecord('sys_user');
user.addNotNullQuery('mobile_phone');
user.addQuery('mobile_phone', 'STARTSWITH', '+316');
user.setLimit(2);
user.query();

// add users to the participant array
while (user.hasNext() && user.next()) {
    gs.log('adding user ' + user.getValue('name') + ' with phone number ' + user.getValue('mobile_phone') + ' to the participant array');
    participants.push(user.getUniqueValue());
}

// define a source record to associate with the conference call
var source = new GlideRecord("cmdb_ci");
source.query("asset_tag", "P1000167");
if (source.hasNext() && source.next()) {
    // set up conference call
    var nn = new SNC.NotifyNow();
    var conferenceCall = nn.initiateConferenceCall(participants, "testing 1 2", source);

    // check if the conference call was successfully created
    if (conferenceCall != null) {
        gs.log('started conference call: ' + conferenceCall.getUniqueValue());
    } else {
        gs.log('could not start the conference call :(');
    }
}
```

**NotifyNow - isCallable(String participant)**

Determines whether a user is callable or not.

A user must have a valid phone number to be callable. A user who is already in an active session is not callable.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>participant</td>
<td>String or GlideRecord</td>
<td>A sys_user or notifynow_participant record, or an E.164-compliant phone number.</td>
</tr>
</tbody>
</table>
### NotifyNow - isSMSCapable()

Checks if the telephone number associated with the Twilio account is capable of sending SMS messages.

#### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>Whether the telephone number associated with the Twilio account is capable of sending SMS messages.</td>
</tr>
</tbody>
</table>

```javascript
gs.log('The twilio number is SMS capable: ' + ((new SNC.NotifyNow().isSMSCapable()) ? 'yes' : 'no'));```

### NotifyNow - isSMSCapable(String userId)

Checks if a user is able to send SMS messages.

```javascript
var nn = new SNC.NotifyNow();
gs.log('by number: ' + nn.isCallable('+31612345678'));

var user = GlideRecord('sys_user');
user.query('sys_id', '13d39544eb5201003cf587b9d106fe9a');
if (user.hasNext() && user.next())
gs.log('by user: ' + nn.isCallable(user));

var participant = GlideRecord('notifynow_participant');
participant.query('sys_id', '33b11430eb1201003cf587b9d106fe99');
if (participant.hasNext() && participant.next())
gs.log('by participant: ' + nn.isCallable(participant));
```
### NotifyNow - isSMSCapable()

Checks if the user can send SMS messages.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>userID</td>
<td>String</td>
<td>The sys_id of the user you want to check for an SMS-capable phone number.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>If the user can send SMS messages.</td>
</tr>
</tbody>
</table>

```javascript
gs.log('the user is able to send SMS messages (e.g. has a SMS device): ' + ((new SNC.NotifyNow().isSMSCapable(&lt;user sys_id&gt;)) ? 'yes' : 'no'));
```

### NotifyNow - isVoiceCapable()

Checks if the telephone number associated with the Twilio account is capable of setting up phone calls.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>Whether the telephone number associated with the Twilio account is capable of setting up phone calls.</td>
</tr>
</tbody>
</table>

```javascript
gs.log('the Twilio number is Voice capable: ' + ((new SNC.NotifyNow().isVoiceCapable()) ? 'yes' : 'no'));
```

### NotifyNow - isVoiceCapable(String userID)

Checks if a user is able to make voice calls.
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>userID</td>
<td>String</td>
<td>The sys_id of the user you want to check for a voice-call capable phone number.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>boolean</td>
<td>Whether the user has a voice-call capable phone number.</td>
</tr>
</tbody>
</table>

gs.log('the user is able to send SMS messages (e.g. has a SMS device): ' + ((new SNC.NotifyNow().isVoiceCapable('someuserid')) ? 'yes' : 'no'));

**NotifyNow - kick(GlideRecord participant)**

Removes a participant from a conference call.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>participant</td>
<td>GlideRecord</td>
<td>The conference call participant to remove from the call.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>True if the participant was removed, otherwise false.</td>
</tr>
</tbody>
</table>

var participantId = "<participant sys_id>";
var participant = new GlideRecord('notifynow_participant');
participant.get(participantId);
if (participant.isValid()) {
    // kick participant
    result = new SNC.NotifyNow().kick(participant);
    gs.log('participant kicked: ' + result);
}

**NotifyNow - mute(GlideRecord participant)**

Mutes a participant on a conference call.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>participant</td>
<td>GlideRecord</td>
<td>The conference call participant to mute.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>True if the participant was muted, otherwise false.</td>
</tr>
</tbody>
</table>

```
var participantId = "<participant sys_id>";
var participant = new GlideRecord('notifynow_participant');
participant.get(participantId);
if (participant.isValid()) {
    // mute participant
    result = new SNC.NotifyNow().mute(participant);
    gs.log('participant muted: ' + result);
}
```

NotifyNow - umute(GlideRecord participant)

Unmutes a participant on a conference call.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>participant</td>
<td>GlideRecord</td>
<td>The muted conference call participant to unmute.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>True if the participant was unmuted, otherwise false.</td>
</tr>
</tbody>
</table>

```
var participantId = "<participant sys_id>";
var participant = new GlideRecord('notifynow_participant');
participant.get(participantId);
if (participant.isValid()) {
    // unmute participant
    result = new SNC.NotifyNow().unmute(participant);
    gs.log('participant unmuted: ' + result);
}
```
**NotifyNow - sendEmailQuestion(String emailAddress, String question, GlideRecord sourceRecord, String emailSubject)**

Send an email question to an email address.

The sendEmailQuestion method produces a question body and requires users to click a link to indicate their choice.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>emailAddress</td>
<td>String</td>
<td>Email address to send the question to.</td>
</tr>
<tr>
<td>question</td>
<td>String or GlideRecord</td>
<td>The question record to send or the sys_id of a question record.</td>
</tr>
<tr>
<td>sourceRecord</td>
<td>GlideRecord</td>
<td>An optional source record to associate to the SMS question, such as an incident.</td>
</tr>
<tr>
<td>emailSubject</td>
<td>String</td>
<td>Optional text to override the default email subject.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The conversation sys_id.</td>
</tr>
</tbody>
</table>

This example demonstrates using the default email subject.

```javascript
var user = GlideRecord("sys_user");
user.get("email", "someone@somedomain.com");

new SNC.NotifyNow().sendEmailQuestion(user.getValue('email'),
"b6b34500bf3111003cf585ce2c0739ce", user);
```

This example uses dot-walking and specifies a source record and email subject.

```javascript
new SNC.NotifyNow().sendEmailQuestion("someone@somedomain.com",
"b6071733bf1111003cf585ce2c07390f", current,
"Please answer this question");
```

This example uses dot-walking and specifies an email subject but no source record.

```javascript
new SNC.NotifyNow().sendEmailQuestion("someone@somedomain.com",
"b6071733bf1111003cf585ce2c07390f",
"Please answer this question");
```
NotifyNow - sendSMS(String phoneNumber, String smsBody)

Sends an SMS message to an E.164-compliant mobile phone number. Notify supports international numbers. Using this method with a number that does not support sending SMS messages results in an error being logged.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>phoneNumber</td>
<td>String</td>
<td>The E.164-compliant phone number to send the message to.</td>
</tr>
<tr>
<td>smsBody</td>
<td>String</td>
<td>The message to send, maximum 1600 characters.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

```
new SNC.NotifyNow().sendSMS("+31612345678", "This is a message without source record");
```

NotifyNow - sendSMS(String phoneNumber, String smsBody, GlideRecord source)

Sends an SMS message to an E.164-compliant mobile phone number. Notify supports international numbers. Using this method with a number that does not support sending SMS messages results in an error being logged.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>phoneNumber</td>
<td>String</td>
<td>The E.164-compliant phone number to send the message to.</td>
</tr>
<tr>
<td>smsBody</td>
<td>String</td>
<td>The message to send, maximum 1600 characters.</td>
</tr>
<tr>
<td>source</td>
<td>GlideRecord</td>
<td>The source record to associate with this SMS message.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>
var source = new GlideRecord("my_table");
source.query("my_field", "my_value");

if (source.hasNext() && source.next()) {
  // send a text message
  var nn = new SNC.NotifyNow();
  var message = "this is just a test";
  var number = "+31612345678";
  nn.sendSMS(number, message, source);
}

This example uses dot-walking and the current record as the source record.

new SNC.NotifyNow().sendSMS("+31612345678", "this is a test", current);

**NotifyNow - sendSMSQuestion(String phoneNumber, String question, GlideRecord sourceRecord)**

Sends an SMS question.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>phoneNumber</td>
<td>An E.164-compliant phone number to send the message to.</td>
<td></td>
</tr>
<tr>
<td>question</td>
<td>String or GlideRecord</td>
<td>The question record to send or the sys_id of a question record.</td>
</tr>
<tr>
<td>sourceRecord</td>
<td>An optional source record to associate to the SMS question, such as an incident.</td>
<td></td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The conversation sys_id, or null if the SMS was not sent successfully.</td>
</tr>
</tbody>
</table>

var question = new GlideRecord("notifynow_question");
question.query();

// get the first question
if (question.hasNext() && question.next()) {
  // send the sms question
  var number = "+31612345678";
  var nn = new SNC.NotifyNow();
  nn.sendSMSQuestion(number, question.getUniqueValue(), current);
**NotifyNow - addConferenceCallParticipant(String conferenceCall, String participant)**

Adds ad-hoc users to an ongoing conference call.

When the method is called with a phone number for the participant parameter and there is exactly one sys_user record that matches the phone number, that sys_user record will be related to the participant. The participant's phone number field will be left blank because the phone number is in the sys_user record. If there are several sys_user records that match the phone number, or if there are no results, the participant's phone number field will be filled in, and there will be no stored reference to sys_user because the user is not known.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>conferenceCall</td>
<td>String or GlideRecord</td>
<td>The sys_id or GlideRecord of an active conference call.</td>
</tr>
<tr>
<td>participant</td>
<td>String or GlideRecord</td>
<td>The sys_id or GlideRecord of a user with an E.164-compliant phone number, or an E.164-compliant phone number.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlideRecord</td>
<td>The participant record of the new participant that was added to the conference call.</td>
</tr>
</tbody>
</table>

```javascript
// add a new participant by conference call sys_id (string) and phone number (string)
var nn = new SNC.NotifyNow();
gs.log(nn.addConferenceCallParticipant('d193b242eb020100a04d4910f206fe39', '+31612345678'));

// add a new participant by conference call sys_id (string) and user record (GlideRecord)
var user = new GlideRecord('sys_user');
user.query('user_name', 'myUserName');
if (user.hasNext() && user.next()) {
  var nn = new SNC.NotifyNow();
  gs.log(nn.addConferenceCallParticipant('d193b242eb020100a04d4910f206fe39', user));
  // you could have added the user by sys_id as well:
} else {
  // handle no results
}
```
// nn.addConferenceCallParticipant('d193b242eb020100a04d4910f206fe39',
user.getValue('sys_id'));
} else {
    gs.log('no such user');
}

// add a new participant by conference call record (GlideRecord) and phone
number (string)
var conferenceCall = new GlideRecord('notifynow_conference_call');
conferenceCall.query('title', 'IA0001001');
if (conferenceCall.hasNext() && conferenceCall.next()) {
    var nn = new SNC.NotifyNow();
    gs.log(nn.addConferenceCallParticipant(conferenceCall, '+31612345678'));
} else {
    gs.log('no such conference call');
}

NotifyNow - convertLocalPhoneNumberToE164(String userID, String
phoneNumber)

Converts a local phone number to an E.164-compliant phone number based on a user’s location.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>userID</td>
<td>String</td>
<td>The sys_id of a sys_user record to get location information from.</td>
</tr>
<tr>
<td>phoneNumber</td>
<td>String</td>
<td>The phone number.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The E.164-compliant phone number.</td>
</tr>
</tbody>
</table>

var localPhoneNumber = '01784 221600';
var userName = 'Heath Vanalphen';

var user = new GlideRecord('sys_user');
user.get('name', userName);
var E164Number = new
SNC.NotifyNow().convertLocalPhoneNumberToE164(user.getUniqueValue(),
localPhoneNumber);
gs.log('converted: ' + localPhoneNumber + ' to ' + E164Number + ' based on ' + 
'user.getUniqueValue('name') + 
'\'s location (' + user.getValue('location') + ')');
**NotifyNow - getConferenceCallParticipants(String conferenceCallId, Boolean isCallable)**

Returns all participants for a conference call.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>conferenceCallId</td>
<td>String</td>
<td>The ID of the conference call.</td>
</tr>
<tr>
<td>isCallable</td>
<td>Boolean</td>
<td>An optional flag to return either only the users you can call (true) or those you cannot call (false).</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlideRecord</td>
<td>The participants</td>
</tr>
</tbody>
</table>

```javascript
var nn = new SNC.NotifyNow();
var user =
    nn.getConferenceCallParticipants('c2e91710eb120100f34087b9d106fe37');

while (user.hasNext() && user.next()) {
    if (user.getValue('participant')) {
        gs.log('user: ' + user.getValue('sys_id'));
    } else {
        gs.log('phone number: ' + user.getValue('phone_number'));
    }
}
```

```javascript
var nn = new SNC.NotifyNow();
var user =
    nn.getConferenceCallParticipants('c2e91710eb120100f34087b9d106fe37', true);

while (user.hasNext() && user.next()) {
    if (user.getValue('participant')) {
        gs.log('user: ' + user.getValue('sys_id'));
    } else {
        gs.log('phone number: ' + user.getValue('phone_number'));
    }
}
```

```javascript
var conferenceCallId = '32b11430eb1201003cf587b9d106feb8';
// get all participants
gs.log('all conference call participants:');
var nn = new SNC.NotifyNow();
```
var user = nn.getConferenceCallParticipants(conferenceCallId);
gs.log(user);

// get all callable participants
gs.log('all conference call participants we can call:');
user = nn.getConferenceCallParticipants(conferenceCallId, true);
gs.log(user);

// get all unavailable participants
gs.log('all conference call participants that are already in an active
session and whom we cannot call:');
user = nn.getConferenceCallParticipants(conferenceCallId, false);
gs.log(user);

**NotifyNow - getFrequentlyCalledUsers(Number limit)**

Returns a number of frequently-called users, up to the limit parameter, in alphabetical order.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>limit</td>
<td>Number</td>
<td>The maximum number of results.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlideRecord</td>
<td>The frequently called users in alphabetical order.</td>
</tr>
</tbody>
</table>

var nn = new SNC.NotifyNow();
var fc = nn.getFrequentlyCalledUsers(10);

while (fc.hasNext() && fc.next()) {
    gs.log("got user " + fc.getValue('name') + ' - ' +
    fc.getValue('sys_id'));
}

**NotifyNow - getPreferredE164VoiceNumber(GlideRecord user)**

Returns a user's preferred E.164-compliant phone number for voice calls.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user</td>
<td>GlideRecord or String</td>
<td>The user record or the sys_id of a user to get the E.164-compliant phone number from.</td>
</tr>
</tbody>
</table>
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The E.164-compliant phone number or null.</td>
</tr>
</tbody>
</table>

```javascript
var userID = "<user sys_id>";
var E164Number = new SNC.NotifyNow().getPreferredE164VoiceNumber(userID);
gs.log('the preferred phone number for setting up voice calls is ' + E164Number + ' for user with id: ' + userID);
```

**NotifyNow - getPreferredE164SMSNumber(GlideRecord user)**

Returns a user's preferred E.164-compliant phone number for SMS messages.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user</td>
<td>GlideRecord or String</td>
<td>The user record or the sys_id of a user to get the E.164-compliant phone number from.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The E.164-compliant phone number or null.</td>
</tr>
</tbody>
</table>

```javascript
var userID = "<user sys_id>";
var E164Number = new SNC.NotifyNow().getPreferredE164SMSNumber(userID);
gs.log('the preferred phone number for sending SMS notifications is ' + E164Number + ' for user with id: ' + userID);
```

**NotifyNow - getPreferredEmailAddress(GlideRecord user)**

Returns a user's preferred email address

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user</td>
<td>GlideRecord or String</td>
<td>The user record or the sys_id of a user to get the email address from.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The email address or null.</td>
</tr>
</tbody>
</table>

```javascript
var userID = "some user sys id";
var email = new SNC.NotifyNow().getPreferredEmailAddress(userID);
gs.log('the preferred email address for sending email notifications is ' + email + ' for user with id: ' + userID);
```

### Live Feed

Live Feed is a social IT application that provides a place to post and share content in a ServiceNow instance.

Live Feed content forms a searchable knowledge source for sharing information within an organization. Main features include the following:

- Users can post, reply to, and rate messages, including links and images.
- Administrators can set up automatic messages that are generated when specific records are updated throughout the system.
- Users can subscribe to receive email notifications when new messages are posted.
- Users who take advantage of the accessibility options in the platform can tab through a live feed to navigate.

Live feed includes different types of feeds.
### My Live Feeds

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Time Ago</th>
<th>Feed ID</th>
<th>Message</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Administrator</td>
<td>Company Feed</td>
<td>16 minutes</td>
<td>W0010007</td>
<td>WM Admin added as an approver</td>
<td>Like · Copy Link · Comment</td>
</tr>
<tr>
<td>System Administrator</td>
<td>Company Feed</td>
<td>16 minutes</td>
<td>W0010007</td>
<td>WM Admin added as an approver</td>
<td>Like · Copy Link · Comment</td>
</tr>
<tr>
<td>System Administrator</td>
<td>Company Feed</td>
<td>16 minutes</td>
<td>W0010007</td>
<td>WM Approver added as an approver</td>
<td>Like · Copy Link · Comment</td>
</tr>
<tr>
<td>System Administrator</td>
<td>Company Feed</td>
<td>16 minutes</td>
<td>W0010007</td>
<td>WM Approver added as an approver</td>
<td>Like · Copy Link · Comment</td>
</tr>
</tbody>
</table>
Live Feed browser support

The Live Feed v2 plugin does not support Internet Explorer 7 through 9. Users who access the instance from those browser versions can use Live Feed v1 functionality. Users who access the instance from browsers that are compatible with HTML5 can use Live Feed v2 functionality.

Activate Live Feed

Live Feed is active for all instances. An administrator can activate the Live Feed plugin if it is not already active.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Administer live feed

Administrators and users with the live_feed_admin role can configure live feed security and provide access to live feed from content management pages. Administrators can also set up live feed table notifications.

Document feeds

A document feed is a live feed group that is associated with a record, such as an incident or change. Document feeds allow users to work on tasks and other records through the live feed interface. Users can post messages in live feed that are automatically maintained as comments or work notes on the record, if the record has these journal fields.

The benefits of using document feeds include the following.

- Improving communication between users working on the same record.
- Improving visibility into progress for end users.
- Providing a single place to see updates on multiple records.
- Saving conversation history in the record so that knowledge is not lost in an email chain.

To use document feeds, activate the Live Feed Document plugin, which is active by default in new instances. See Use live feed to work on records to learn how to use this feature.
The system automatically creates a document group for the feed when a user follows or shows a record on live feed. The system also creates a document group when a user creates a new record on a table that has live feed enabled.

The following list describes features of the document feed group.

- Is unlisted; it does not appear when users view all groups on live feed.
- Automatically approves membership for every user who can access the record.
- Uses the record number as the group name.
- Uses the record short description as a group description.
- Maintains all messages posted to live feed on the record, if the record has a journal field for comments. If the record has a standard text field for comments, each live post overwrites the field value.
- Maintains all messages posted on the record in live feed if the record has a journal field for comments. When the group is created, existing messages are added to the document feed.

A user who participates in live feed becomes a member of the group.

Add a live feed UI action on a table

You can add UI actions on a table to allow users to follow records in live feed.

Role required: ui_action_admin or admin

1. Navigate to System Definition > UI Actions.
2. Open one of the live feed UI actions, for example, the Follow on Live Feed list UI action.
3. In the Table field, select the table name.
4. Right-click the header and select Insert to create a copy of the UI action for the desired table.
5. Repeat steps 1 – 4 for all live feed UI actions.

Configure document feeds

You can configure a table to support document feeds.

Role required: personalize_dictionary or admin

Configuring a table to support document feeds includes the following steps:

1. Add live feed to a form header.
2. Add Follow on Live Feed and Show Live Feed as list and form UI actions.

Security configuration for document feeds

Document feeds honor the access control rules (ACLs) for the associated record. Users can only view messages on the document feed if they have access to the same information on the record.

Consider the following examples.

- If an ACL allows a user to read and create comments on an incident, then the user can view and add messages posted as comments on the incident feed.
- If an ACL restricts a user from reading work notes, then the user cannot view messages posted as work notes on the incident feed.

**Note:** Access control rules are only checked when a user first accesses the document feed. After users view the feed, an administrator must remove them manually to change their access.

Disable a record feed

You can disable live feed functionality from the form of any table.
Role required: personalize_dictionary or admin

1. Navigate to **System Definition > Dictionary**.
2. Open the dictionary entry for the table.
3. Add `live_feed=false` in the **Attributes** field.
4. Click **Update**.

**Note:** If the Collaboration feature is activated, you can remove the show live feed icon from all form headers. Set the `glide.live_feed.task_header_button` property to `collaboration`.

---

Disable a document feed

You can disable a document feed from the form of any table.

Role required: personalize_dictionary or admin

1. Navigate to **System Definition > Tables**.
2. Open the table record.
3. Clear the **Live feed** check box.
4. Click **Update**.

---

**Business rule installed with Live Feed Document**

This business rule is installed with Live Feed Document. There are no tables, roles, or notifications installed with it.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live Feed integration</td>
<td>Writes journal comments to the live feed if there is a group for this record.</td>
</tr>
</tbody>
</table>

---

**Record feeds**

A record feed is a live feed group that is associated with a record, such as an incident or change.

Record feeds allow users to work on tasks and other records through the live feed interface. Users can post messages in live feed that are automatically maintained as comments or work notes on the record if the record has these journal fields.

You can use record feeds to:

- Improve communication between users working on the same record.
- Improve visibility into progress for end users.
- Provide a single place to see updates on multiple records.
- Save feed history in the record so that knowledge is not lost in an email chain.
Live feed document

**Note:** Many of these features are part of live feed v2.

**Activate live feed document**

The Live Feed Document plugin is active by default.

Administrators can enable record feeds in an instance by activating the Live Feed Document plugin, which activates the Live Feed plugin, if it is not active. For upgrades, administrators must activate the plugin.

1. Navigate to **System Applications > All Available Applications > All.**
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Configure record feeds**

Configure a table to support record feeds. You can add the Show Live Feed button in the form header and add the UI actions Follow on Live Feed and Show Live Feed as List and Form.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
By default, the Show Live Feed icon appears on the form header for all tables that extend task, including the Incident, Change Request, and Problem tables, and in the list and form context menus for all task tables.

**Add live feed to a form header**

Add the Live Feed button in the form header for a table.

1. Type `sys_properties.list` in the Application Navigator.
2. Open the record for `glide.live_feed.task_header_button`.
3. In the Value field, change the value to `both`.

   **Note:** By default, the value is `collaboration` so that the property is supported in the Collaboration (com.glide.collaboration) plugin. Changing the value to `both` allows the system property to be supported in Collaboration and Live Feed.

4. Click **Update**.
5. Navigate to **System Definition > Tables**.
6. Open the table record.
7. If the Live feed check box does not appear on the form, configure the form layout to add the Live feed field.
8. On the form, select the Live feed check box.
9. Click **Update**.

   Alternatively, you can add `live_feed=true` to the Attributes field in the dictionary entry for the table.

The Live Feed button appears on the overflow menu of the form header.
**Add live feed to a context menu**
Add live feed UI actions on a table.

1. Navigate to **System Definition > UI Actions**.
2. Open one of the live feed UI action, for example, **Follow on Live Feed**.
3. In the **Table** field, select the table name.
4. Right-click the header and select **Insert** to create a copy of the UI action for the desired table.
5. Repeat steps 1 – 4 for all live feed UI actions.

**Disable a record feed**
You can disable live feed functionality from the form of any table.

Role required: personalize_dictionary or admin

1. Navigate to **System Definition > Dictionary**.
2. Open the dictionary entry for the table.
3. Add `live_feed=false` in the **Attributes** field.
4. Click **Update**.

**Configure security**
Record feeds honor the access control rules (ACLs) for the associated record.

Users can only view messages on the record feed if they have access to the same information on the record. For example:

- If an ACL allows a user to read and create comments on an incident, then the user can view and add messages posted as comments on the incident feed.
- If an ACL restricts a user from reading work notes, then the user cannot view messages posted as work notes on the incident feed.

**Note:** Access control rules are only checked when a user first accesses the record feed. After users view the feed, an administrator must remove them manually to change their access.

**Live feed table notifications**
Live feed table notifications generate automatic live feed messages. The Live Feed plugin must be activated to use table notifications.

When a record is inserted or updated on a specific task table and the notification conditions are met, a message is generated and posted to the specified group or to the company feed. Table notifications are supported for all task tables and all task types by default.

Administrators and users with the `live_feed_admin` or `chat_admin` roles can set up table notifications for any table in an instance.

**Set up table notifications for task tables**
You can set up a table notification for a task table to enable automatic live feed messages.
Role required: live_feed_admin or chat_admin

1. Navigate to **Live Feed > Feed Administration > Table Notifications**.
2. Click **New** or select a notification to open it.
3. Complete the form.

### Live Table Notification fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table</strong></td>
<td>Select the table for which notifications are generated.</td>
</tr>
<tr>
<td><strong>Post to chat rooms</strong></td>
<td>Select the check box to generate the notification in chat rooms that are associated with the record. This applies to task records only and requires that the Chat plugin is active.</td>
</tr>
<tr>
<td><strong>Post to live feed</strong></td>
<td>Select the check box to generate the notification on live feed.  If record feeds are not set up and the <strong>Feed group</strong> field is blank, the notification is posted to the company feed.</td>
</tr>
<tr>
<td><strong>Record Feeds</strong></td>
<td>Select the fields to post for record feeds.</td>
</tr>
<tr>
<td><strong>Application</strong></td>
<td>Select the application that contains this record.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Select the check box to enable the notification.</td>
</tr>
<tr>
<td><strong>Insert</strong></td>
<td>Select the check box to generate the notification when a record is inserted into the database.</td>
</tr>
<tr>
<td><strong>Update</strong></td>
<td>Select the check box to generate the notification when a record is updated.</td>
</tr>
<tr>
<td><strong>Feed</strong></td>
<td>Select the live feed team to which you want to post messages. This field is available only if <strong>Post to live feed</strong> is selected. Clear the field to post notifications on the company feed.</td>
</tr>
<tr>
<td><strong>Conditions</strong></td>
<td>Create the condition that must be met to generate the notification.</td>
</tr>
<tr>
<td></td>
<td>If you add a condition statement, the system evaluates the condition first and parses the <strong>Before script</strong> field only if the condition is met. You may choose to leave this field blank and include conditions in the script.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Enter a description of the table notification.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Message</td>
<td>Construct the automatic message you want to generate. You can include field values as variables and a link to the record. To add a variable, position the cursor in the text and then click the field name in the Select variables field. To add a link to the record, enter <code>${URI}</code> in the message text as shown in the following example. High priority incident opened: <code>${URI}</code> Short description: <code>${short_description}</code> Note: For security reasons, any HTML code is automatically stripped out of a message before it is posted.</td>
</tr>
<tr>
<td>Before script</td>
<td>Create a script that runs before a notification is generated. The script runs only if the condition evaluates to true or is empty. The following variables are available in the script. • current: the GlideRecord object that triggered the notification. • changedFields: an ArrayList of fields changed on submit. Use changedFields.contains('fieldname') to check for change. • answer: set answer to false to cancel the notification. • profileSource: set to a valid GlideRecord object to define the profile that is posting the message. • profileID: set to a live_profile sys_id to define the profile that is posting the message; by default it is the current record. Overrides profileSource if both are specified. Any custom variable created in the script is also exposed to the message in the form of <code>${myVariableName}</code>.</td>
</tr>
</tbody>
</table>
5. Click New.

6. Enter the following values at the top of the form.
   - **Name**: Enter a name, such as *live feed events for my table*.
   - **Table**: Select the table for which you are setting up a notification.
   - **Active** and **Advanced**: Select these check boxes.

7. In the **When to run** section, enter the following values.
   - **When**: Select *before*.
   - **Insert**, **Update**, and **Delete**: Select the check boxes.

8. In the **Advanced** section, paste the script from the *live feed events* business rule into the script box.

9. Click **Submit**.
   The *live feed events* business rule runs on the non-task table. It fires the *live_feed.update* event, which is associated with the *Live Feed Update* script action. The script action sets up variables and processes the table notifications.

After saving the business rule, create a *live feed table notification record* for the new table as you would for a task table.

**Live feed table notification examples**

The following examples demonstrate how to set up different types of table notifications that are useful for live feed.

**Workaround posted**

This example demonstrates a table notification that generates an automatic message on live feed whenever a workaround is added to an open problem.

- **Table**: Problem [problem]
- **Active**: Select the check box.
- **Update**: Select the check box.
- **Post to live feed**: Select the check box.
- **Conditions**: [State] [is] [Open]
- **Description**: Workaround Posted
- **Message**:

  ```
  ${sys_updated_by} posted a workaround for ${URI}.
  Short description: ${short_description}
  ```

- **Before script**:

  ```
  // only post to live feed when the Workaround field changes
  ```
Example workaround message

**Problem resolved (advanced)**
This advanced example demonstrates a table notification that generates an automatic message on live feed whenever a problem is closed.

It also adds a message about the assigned user and posts the message from the assignment group profile instead of the problem record.

- **Table**: Problem [problem]
- **Active**: Select the check box.
- **Update**: Select the check box.
- **Post to live feed**: Select the check box.
- **Conditions**: [Problem State] [is] [Closed/Resolved]
- **Description**: Problem Resolved
- **Message**:

  Problem \$number\ - \$short_description\ has been resolved. \$fixedByMsg

- **Before script**:

  ```javascript
  //cancel if we didn't just change the problem state if ( !changedFields.
  contains ( "problem_state" ) )
  answer  = false ;
  ```
Example problem resolved message

Opportunity won (non-task)
This example demonstrates a table notification on a non-task table. It generates an automatic message on live feed whenever a sales opportunity is won, if you have activated the Sales Force Automation plugin.
Create a business rule on the Opportunity [sales_opportunity] table that matches the live feed events business rule on the task table.

Create a table notification with the following values:

- **Table**: Opportunity [sales_opportunity]
- **Active**: Select the check box.
- **Update**: Select the check box.
- **Post to live feed**: Select the check box.
- **Conditions**: [State] [is] [Closed Won]
- **Description**: Opportunity won
- **Message**:

\[
\text{$(owner)$ closed a sale with $(account)$!}
\]

- **Before script**:

```java
//make the message appear to come from the assigned salesperson if there is one if ( !current. owner. nil () )
profileSource  = current. owner. getRefRecord () ; //need GlideRecord object
```

Example opportunity won message

**Related feeds table notification**

This example demonstrates table notifications to be sent out to related feeds.
For this example, whenever the status of a story changes to **Complete**, a table notification message is sent to the related sprint, release, or epic. Messages are posted only if the related feed already exists; this notification does not create a new feed.

- **Table**: Story [rm_story]
- **Active**: Select the check box.
- **Update**: Select the check box.
- **Post to live feed**: Select the check box.
- **Record feeds**: Move **Sprint**, **Release**, and **Epic** to the **Selected** column.
- **Conditions**: [State] [changes to] [Complete]
- **Description**: Story is done; message to Epic, Release, and Sprint
- **Message**: ${URI} status changed to ${state}

### Live feed security and table access

By default, administrators and users with the live_feed_admin role can configure live feed security and view all live feed tables.

You can also modify the following live feed tables.

- **Live Table Notification** [live_table_notification]: set up automatic messages that are generated when specific records are updated throughout the system.
- **Live Feed Message** [live_message]: modify only if necessary, such as to delete an inappropriate message or restore a message that a user accidentally deleted. This table is typically managed by system functionality.

Extending or modifying data in any live feed chat table is not recommended.

### Domain separation in Live Feed

This is an overview of domain separation and Live Feed. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

#### Overview

**Support: Level 2**

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

Parent and child domains define the live feed content that can be viewed and shared with other users.

- A user in a parent domain can see users and content within their domain and within all child domains that are lower in the domain hierarchy.
- A user in a child domain can see users and content within their domain but cannot see the parent domain or other child domains at the same level in the domain hierarchy.

**Enable domain separation for live feed**

Domain separation for the Live Feed application is available starting with the Eureka release. For users upgrading to Eureka, a sys_domain column is added to existing live feed-related database tables.
existing database records, the value of the sys_domain field is set to empty (global). This allows the
domain separation feature to work with existing live feed records.

Show or hide the live feed application for a domain

The administrator can live feed visibility for a domain. This includes:

- Displaying live feed in the application navigator.
- Following a document feed for a record.
- Viewing live feed from a record.

Use live feed with domain separation

All of the live feed features are available to users within a domain and work the same way, with some
exceptions to visibility.

- **Posting and sharing content**
  - Users in a child domain can interact with other users in the same domain. This includes posting and
    replying to messages, deleting messages, attaching files and links, and rating content.
  - Users in a parent domain can interact with other users in the same domain and with users in any
    child domains. Messages that are added to child threads by parent users are given the visibility of
    the child domain, not the parent domain.

- **Viewing content**
  - Users in a child domain can view content that resides within their domain. This includes filtering by
    feed, sorting, searching, and viewing older messages.
  - Users in a parent domain can view content that resides within their domain and within any child
    domains.
  - My Feed shows messages, teams, and hashtags based on the user's domain. Showing another
    user's feed only shows posts visible in the current user's domain.

- **Using hashtags**
  - Hashtags are separated by domain. Users in a child domain can use all of the hashtag functions
    within their domain. This includes tagging messages, viewing available hashtags, changing hashtag
    names, and searching and filtering by hashtag.
  - Users in a parent domain can use all of the hashtag functions within their domain and can see
    hashtags in any child domains.

- **Using teams**
  - Teams are separated across domains. Users in a child domain can join and follow teams within their
    domain, and can invite other users within their domain to join teams.
  - Users in a parent domain can join and follow teams that belong to their domain or to any child
    domains.
• **Exceptions to teams**
  - New teams are created in the user's domain. However, if the team has a record associated with it, the team is created in record's domain.
  - New threads in an existing team are created in the domain of the existing team.
  - When a user is creating a new team from a document, if the document domain is not empty or global, the team domain needs to be changed to be the document's domain.
  - For a document-generated team, when the domain of the document changes, the domain of all related live feed records changes as well.

• **Subscribing to email notifications**
  - Users can subscribe to email notifications from users and teams within their domain only.

**Limit live feed access by role**
All active users in the instance have access to live feed by default.

*live_feed_admin* and *admin*

1. Complete the following steps to define the roles that allow users to see the Live Feed module.
   a) Perform the appropriate action for your version of the UI:
      - UI16: Navigate to **System Definition > Application Menus > Live Feed** and select **Live Feed**.
      - UI15: Right-click the icon beside the Live Feed module and select **Edit Module**.
   b) Enter the roles that have access in the **Roles** field.
   c) Click **Update**.

2. Complete the following steps to define the roles that allow users to see live feed from a mobile device.
   a) Navigate to **System Definition > Applications (Mobile)**.
   b) Click **Live Feed**.
   c) Enter the roles that have access in the **Roles** field.
   d) Click **Update**.

3. Use the following settings in the Access Control form to create access control rules to limit who can view the live_feed pages.
   - **Type**: *ui page*
   - **Operation**: *read*
   - **Name**: create one access control rule record for each of the following pages
     - live_feed
     - live_feed_small
     - $live_feed
     - $live_feed_small
   - **Requires role**: in this related list, add roles to define who can access the live feed pages. Users who do not have these roles cannot access live feed.

**Manage live feed message content**
Users can remove their own messages from feeds. If necessary, administrators can remove inappropriate messages that are posted by any user.
live_feed_admin and admin

For security reasons, any HTML code is automatically stripped out of a message before it is posted. This measure ensures that users cannot modify any page settings by posting a message.

1. Navigate to Live Feed > Feed Administration > Messages.
2. Open the message to be removed.
3. In the State field, select deleted. You may need to configure the form to add this field.
4. Click Update.

Live feed team security

You can restrict who can create teams by modifying an access control rule.

Modify the following access control rule.

- **Table**: Live Group Profile [live_group_profile]
- **Operation**: create

Restrict hashtag renaming

You can restrict who can rename hashtags.

You restrict hashtag rename by modifying the following access control rule:

- **Table**: Live Tag [live_tag]
- **Operation**: write

Provide access to live feed from CMS pages

You can provide access to live feed from pages built in the Content Management System (CMS). For example, allow an end user to access your company feed via the ESS portal.

Role required: content_admin or admin

The ESS Portal template includes the Portal - Live page and Live Feed dynamic blocks. To provide access to live feed from CMS pages, add the Live Feed dynamic block to a CMS page or include Portal - Live page in a site.

1. Navigate to Content Management > iFrames.
2. Click New.
3. Enter the iFrame block details.

### iFrame block fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name such as Live Frame.</td>
</tr>
<tr>
<td>Frame Name</td>
<td>Enter a frame name, such as live_frame.</td>
</tr>
<tr>
<td>URL</td>
<td><a href="https://INSTANCE/live_feed.do?sysparm_doctype=true">https://INSTANCE/live_feed.do?sysparm_doctype=true</a></td>
</tr>
<tr>
<td></td>
<td>where INSTANCE is your instance URL (example, [instance name].service-now.com)</td>
</tr>
<tr>
<td>Application</td>
<td>Displays scoping information.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sizing</td>
<td>Select <strong>Fixed Size</strong> and enter height and width pixel dimensions according to the page where you plan to display the feed (for example, width of 1024 and height of 768).</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
5. Add the block to a page.

**Components installed with live feed**

Several types of components are installed with Live Feed.
Demo data is available with Live Feed.

**Tables installed with live feed**

Live Feed plugin installs the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link attachments [live_link]</td>
<td>Stores links and attachments that are added to messages.</td>
</tr>
<tr>
<td>Live Favorite [live_favorite]</td>
<td>Stores the favorite conversations, user groups, and messages.</td>
</tr>
<tr>
<td>Live Feed Searches [live_feed_search]</td>
<td>Stores live feed text searches. Access at <strong>Live Feed &gt; Feed Administration &gt; Search Log</strong>.</td>
</tr>
<tr>
<td>Live Follows [live_follow]</td>
<td>Maintains users’ follow preferences for user feeds.</td>
</tr>
<tr>
<td>Live Group Profile [live_group_profile]</td>
<td>Stores conversation properties, including name, description, and public status. Also stored are user group properties, such as name, description, and public status.</td>
</tr>
<tr>
<td>Live Group Member [live_group_member]</td>
<td>Maintains the member lists for conversation and user group.</td>
</tr>
<tr>
<td>Live Mention [live_mention]</td>
<td>Stores the profiles mentioned in a message. References sys_user table.</td>
</tr>
<tr>
<td>Live Message Tag [live_message_tag]</td>
<td>Stores messages associated with user-created tags. Appears as a related list on Live Tag records.</td>
</tr>
<tr>
<td>Live Messages [live_message]</td>
<td>Stores messages. References sys_user table. Access at <strong>Live Feed &gt; Feed Administration &gt; Messages</strong>.</td>
</tr>
<tr>
<td>Live Poll [live_poll]</td>
<td>Stores a poll question.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Live Poll Cast [live_poll_cast]</td>
<td>Stores profiles of users who voted for a particular option in a poll.</td>
</tr>
<tr>
<td>Live Poll Options [live_poll_option]</td>
<td>Stores poll options.</td>
</tr>
<tr>
<td>Live Table Notification [live_table_notification]</td>
<td>Generates automatic table notifications, such as when a user reads live feed for the first time and when a high priority incident is opened. Access at Live Feed &gt; Feed Administration &gt; Table Notifications.</td>
</tr>
<tr>
<td>Live Tag [live_tag]</td>
<td>Maintains user-created tags. Access at Live Feed &gt; Feed Administration &gt; Tags.</td>
</tr>
</tbody>
</table>

**User roles installed with Live Feed**

Live Feed plugin installs the following user roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
</table>
| live_feed_admin        | Can manage live feed functions. For example, users with the live_feed_admin role can:  
  • Set up table notifications for task tables.  
  • Set up table notifications for non-task tables.  
  • Limit live feed access by role.  
  • Manage live feed message content.                                                                                                                                                                                                                                                                                                                                 |
| chat_admin             | Can manage chat functions (if the Chat plugin is activated). For example, users with the chat_admin role can:  
  • Change chat room message read access.  
  • Define chat room access rights.                                                                                                                                                                                                                                                                                                                                         |

**Script includes installed with Live Feed**

Live Feed plugin installs the following script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LiveMsgUtil</td>
<td>Provides helper functions for working with live_message records.</td>
</tr>
</tbody>
</table>
### Name | Description
--- | ---
LiveFeedFilter | Queries filters for working with live_feed records.  
LiveFeedUtil | Provides helper functions for working with live_feed records.  

### Business rules installed with Live Feed
Live Feed plugin installs the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| Feed Group Creator Becomes Admin | Live Group Profile [live_group_profile] | Designates the group creator as the group administrator.  
| live feed events | Task [task] | Runs on task insert, update, and delete. Triggers event associated with the Live Feed Update Script action that processes Live Table Notifications to auto-generate live feed messages.  
| Live feed member update events | Live Group Member [live_group_member] | Generates a notification event when member state changes (invited, accepted, declined, left, rejected, request, request_accepted).  
| Live feed integration | Journal Entry [sys_journal_field] | Writes journal comments to the live feed if there is a group for this record.  
| Live feed new member events | Live Group Member [live_group_member] | Generates a notification event when new members are added.  
| live feed profile events | Live Profile [live_profile] | Runs on live_profile insert/update/delete, triggers event associated with the Live Feed Update script action that processes Live Table Notifications to auto-generate live feed messages.  
| Live Feed message events | Live Feed Message [live_message] | Runs on live_message, notification event trigger for new live messages.  
| Live message like events | Message Liked by [live_message_like] | Runs on live_message_like, notification event trigger for new like records.  
| LiveFeed Group Member Visibility 2.0 | Live Group Member [live_group_member] | Ensures users can only see the members list for public groups and groups they belong to.  
| LiveFeed Group Profile Validation | Live Group Profile [live_group_profile] | Ensures that a public group is visible.  

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LiveFeed Group Profile Visibility 2.0</td>
<td>Live Group Profile</td>
<td>Ensures that the list of all groups only displays public groups, private groups that are visible, and groups the user belongs to.</td>
</tr>
<tr>
<td></td>
<td>[live_group_profile]</td>
<td></td>
</tr>
<tr>
<td>LiveFeed Membership Changes</td>
<td>Live Group Member</td>
<td>Ensures that only the group administrator and users with live_feed_admin role can manage membership for a group.</td>
</tr>
<tr>
<td></td>
<td>[live_group_member]</td>
<td></td>
</tr>
<tr>
<td>LiveFeed Single Group Membership</td>
<td>Live Group Member</td>
<td>Ensures that a user is not added multiple times to the same group.</td>
</tr>
<tr>
<td></td>
<td>[live_group_member]</td>
<td></td>
</tr>
<tr>
<td>Live Message Likes</td>
<td>Live Message Like</td>
<td>Updates the number of likes for a message.</td>
</tr>
<tr>
<td></td>
<td>[live_message_like]</td>
<td></td>
</tr>
<tr>
<td>LiveFeed Join Group Check</td>
<td>Live Group Member</td>
<td>Ensures that users cannot automatically join private visible groups.</td>
</tr>
<tr>
<td></td>
<td>[live_group_member]</td>
<td></td>
</tr>
<tr>
<td>Update Follow/Follower Counts</td>
<td>Live Follow</td>
<td>Updates the following/followers counts.</td>
</tr>
<tr>
<td></td>
<td>[live_follow]</td>
<td></td>
</tr>
<tr>
<td>Live Feed Group</td>
<td>Assessable Record</td>
<td>Creates/Deletes a live feed group for an assessable record.</td>
</tr>
<tr>
<td></td>
<td>[asmt_assessable_record]</td>
<td></td>
</tr>
<tr>
<td>Live Feed Message Visibility</td>
<td>Live Feed Message</td>
<td>Ensures user's access to live feed messages.</td>
</tr>
<tr>
<td></td>
<td>[live_message]</td>
<td></td>
</tr>
</tbody>
</table>

**Email notifications installed with Live Feed**

Live Feed plugin installs the following email notifications..

<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live Feed Feed Member Accepted</td>
<td>Sends an email to the administrator when a user has accepted to join the feed.</td>
</tr>
<tr>
<td>Live Feed Feed Member Declined</td>
<td>Sends an email to the administrator when a user has declined to join the feed.</td>
</tr>
<tr>
<td>Live Feed Feed Member Invited</td>
<td>Sends an email to a user when they have been invited to join a feed.</td>
</tr>
<tr>
<td>Live Feed Feed Member Left</td>
<td>Sends an email to the administrators when a user has left the feed.</td>
</tr>
<tr>
<td>Live Feed Feed Member Removed</td>
<td>Sends an email to user when they have been removed from the feed.</td>
</tr>
<tr>
<td>Live Feed Feed Member Request</td>
<td>Sends an email to administrators when an user requests to join a feed.</td>
</tr>
<tr>
<td>Live Feed Feed Member Request Accepted</td>
<td>Sends an email to the user when their request to join a feed is accepted.</td>
</tr>
<tr>
<td><strong>Email notification</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Live Feed Feed Request Rejected</td>
<td>Sends an email to the user when their request to join a feed has been rejected by an administrator.</td>
</tr>
<tr>
<td>Live Feed MsgReply Subscription</td>
<td>Sends an email when a reply or reply_to_reply message is inserted into the thread of a message in a feed.</td>
</tr>
<tr>
<td>Live Feed Team Member Accepted</td>
<td>Sends an email to administrators when a user accepts an invitation to join a team.</td>
</tr>
<tr>
<td>Live Feed Team Member Declined</td>
<td>Sends an email to administrators when a user declines an invitation to join a team.</td>
</tr>
<tr>
<td>Live Feed Team Member Invited</td>
<td>Sends an email when a user is invited to join a team.</td>
</tr>
<tr>
<td>Live Feed Team Member Left</td>
<td>Sends an email when a user leaves a team.</td>
</tr>
<tr>
<td>Live Feed Team Member Removed</td>
<td>Sends an email when an administrator has removed a user from a team.</td>
</tr>
<tr>
<td>Live Feed Team Member Request</td>
<td>Sends an email when a user requests to join a team.</td>
</tr>
<tr>
<td>Live Feed Team Member Request Accepted</td>
<td>Sends an email when a user's request to join a team is accepted.</td>
</tr>
<tr>
<td>Live Team Member Request Rejected</td>
<td>Sends an email when a user's request to join a team is rejected.</td>
</tr>
<tr>
<td>Live Message All Subscription</td>
<td>Sends an email to subscribed users when any message (new or reply) is posted.</td>
</tr>
<tr>
<td>Live Message Feed Subscription</td>
<td>Sends an email when a new message is inserted into a feed.</td>
</tr>
<tr>
<td>Live Message Liked</td>
<td>Sends an email to the creator of a message when another user likes the message.</td>
</tr>
<tr>
<td>Live Message Mention</td>
<td>Sends an email to a user when that user is mentioned in a message.</td>
</tr>
<tr>
<td>Live Message New Posts Subscription</td>
<td>Sends an email to subscribed users when a new (not reply) message is posted.</td>
</tr>
<tr>
<td>Live Message Reply</td>
<td>Sends an email to all users in a feed thread when a user posts a reply (live_message.replied event).</td>
</tr>
</tbody>
</table>

**Use Live Feed**

Live Feed provides many methods you can use to share content with others in your organization. Depending on your role, there are several different types of feeds you can access, teams you can join and share information with, and hashtags you can use for categorizing messages.
Company Feed

System Administrator
23 minutes ago
#MacBook tag testing
Like · Copy Link · Hashtags (1) · Comment

System Administrator
23 minutes ago
now it is working fine
Like · Copy Link · Comment

System Administrator
2 years ago
We're considering using Live Feed to replace #Lync for collaboration. Thoughts?
Like · Copy Link · Hashtags (1)

Ramon Amaral
Excellent idea! So much easier to use and we already use it for everything else.
Note: Live Feed v2 is active for all new instances by default. If you are upgrading from an earlier version of ServiceNow, you need to activate Live Feed v2 to use these features.

Use hashtags in Live Feed

Hashtags are words marked with a hash symbol (#) in messages. Hashtags are a way to categorize messages by keyword or topic for improved search results.

For example, to identify messages associated with VPN questions, add the hashtag #VPN in the message text.

Note: Many of these features are part of live feed v2. If you are using live feed v1, or have not activated live feed v2, see Legacy Live Feed.

Tag messages

To tag a keyword or topic in a message, enter a # symbol before the word. A link to the hashtag is added beneath the message and all feed users can search and filter by the hashtag to find the message.

Tips for using hashtags effectively include:

- Limit the number of hashtags per message (no more than 3 is a good guideline).
- Use hashtags only in messages that are relevant to the tagged topic.
- Write a message first, and then add hashtags only if they add value. Answer the question, "What are you working on?", rather than "What hashtags apply to what you are working on?"
- Use camel case to create a hashtag that is more than one word long. For camel case, remove the space and use an uppercase letter to start each word. For example, to create a topic about the service desk, use #ServiceDesk.
Tag

View an available hashtag
View a hashtag from any feed.
1. Navigate to Live Feed > Live Feed.
2. Click **Hashtags** in the sidebar. Any hashtags already defined are displayed. Up to 36 hashtags can be displayed, and options are available for searching and sorting the hashtags. When searching, you do not need to include the hash symbol (#).

![Tags sidebar](image)

3. Click a hashtag to view all messages containing that hashtag.

![Tags multiple messages](image)
Change a hashtag name and merge a hashtag

Over time, users may create many hashtags with similar names, such as competitive, competitor, and competition. To combine hashtags for better searching and filtering, change the names of similar hashtags to a standard name.

Administrators can restrict who can rename hashtags.

1. Navigate to Live Feed > Live Feed.
2. Click Hashtags in the sidebar to reveal the currently defined hashtags.
3. Turn off the filter to show all hashtags.
4. Point to the hashtag you want to change. If you have the rights to edit hashtags, an edit tag (✏️) appears.
5. Click the edit tag icon.

Hashtags

![Hashtags](image)

6. Enter a new hashtag name.
7. Press Enter.
   - If the new name is different than the other hashtags, the new hashtag name replaces the old hashtag name on the list and in the text of any messages that include the hashtag.
   - If the name is the same as one of the existing hashtags, the hashtags will be merged. For example, if you have two hashtags called Competitive and Competitors, and you change the name of Competitors to Competitive, all of the messages previously tagged Competitors are changed to Competitive and the Competitors hashtag is removed.

Note: If a hashtag is removed from the message, renaming that hashtag does not change the message text.

Add an image to a hashtag

You can add an image at the domain level of already defined hashtags if you have the admin role.

1. Click Hashtags in the sidebar.
2. Select the appropriate hashtag.

#VPN Feed

Tag with image icon

3. Do one of the following:
   - Locate the image in your file system, and then drag-and-drop the image onto the add an image icon ( ).
   - Click the add an image icon ( ), select the image file, and click Open.

4. To change the image, simply drag-and-drop a new image onto the old one, or click on the existing one and select a new image.

When you view a message that contains a hashtag with an image, that image appears in the hashtag heading bar.

#WiFi Feed

Joe Employee
2 years ago

Anyone in building 3 having trouble connecting to #WiFi?
Like • Copy Link • Hashtags (1)

Lee Javens I was. Disconnect and reconnect. Back up now. I'm down the hall if you need help.
2 years ago • Like (1) • Reply

Taylor Fogerty Yes. Same issues here.
2 years ago • Like • Reply

Message with tag icon
Follow and unfollow a hashtag

You can view all postings assigned a specific hashtag by following the hashtag. You can also unfollow the hashtag if you no longer want to view those postings.

1. Navigate to Live Feed > Live Feed.
2. Click Hashtags in the sidebar.
3. Select the hashtag you want to follow.
4. Click Follow.

A confirmation message appears.

5. Click X to dismiss the message.

To unfollow a hashtag, repeat the same steps and click Unfollow.

Bookmark hashtags

The live feed interface uses the standard bookmarking functionality for hashtags.

In UI15, the live feed interface uses the standard bookmarking functionality for hashtags. You can drag-and-drop group feeds and hashtags from the Feed Summary section to the Edge for quick access.
Bookmark hashtag

Remove a hashtag from a posted message

As a participant in a conversation, you can remove hashtags from messages that have already been posted.

1. Navigate to the posted message.
2. Click **Hashtags** in the message posting.

![Hashtag in post]

The hashtags associated with the message are displayed, along with the removal icon.

![Remove tag](https://via.placeholder.com/150)

3. Click the removal icon.

**Use teams in Live Feed**

Users can be combined into teams for the purpose of subscribing to specifically-focused feeds.

Teams can be created based on any criteria that makes sense for your organization. For example, you can create a team called IT Developers and subscribe the team to feeds such as Coding Standards, AngularJS Development, and ServiceNow Customization Best Practices. When a new developer is added to the IT Developers team, that user automatically has rights to participate in all of the feeds followed by the team.

**Create a live feed team**

When you create a team, you become the team administrator.

As team administrator, you can:

- Modify team properties
- Accept or reject membership requests
- Remove members from the team
- Delete the team

1. Navigate to **Live Feed > Live Feed**.
2. In the sidebar, click your profile picture, then select the **Teams** tab.

3. Click **Create Team**.

4. Enter a **Name** to appear at the top of the feed and in messages posted to the team. This name links to the team feed.
5. Enter a **Description** to appear at the top of the feed and under the team name in the list of all teams.

6. Select the access level for the team:

   - **Public Team**: In the list of all teams, any user can see the name of this team. Any user can also see the feed and join the team. Messages in a public team appear in the Company Feed with a link to the team feed.
   
   - **Private Team**: In the list of all teams, any user can see the name of this team, but not the feed. Messages in private teams do not appear on the Company Feed.

   When **Private Team** is selected, the **Show this team for anyone to find and request to join** check box is displayed. Select this check box to allow any user to search for this team and request to join it. Clear the check box to allow only invited users to see the feed and join the team.

7. Click **Create**.

The team is created with you as the team administrator.

---

**Note:** A team administrator can create one or more group feeds specifically for the members of this team by clicking the **Group Feeds** tab and **Create Group Feed**. Additionally, the team can be invited to join a feed. Having multiple feeds for the team facilitates focused discussions on topics of interest to the team and allows the team to selectively invite other teams and members to collaborate on specific feeds.
**Automatic team creation**

If you create a record on a table that has live feed enabled, such as the Incident table, and click Follow/Show Live Feed for the record, a record feed is created for the record.

The record feed name is based on the table name.

**Join a team**

You can join a public team, accept an invitation, or request access to a team.

As a team member, you can:

- View messages posted to the team (team feed). Non-members can also view the feed for a public team.
- View a list of team members.
- Invite another team to join the team.
- Subscribe to team email notifications.
- Leave the team.

1. Navigate to Live Feed > Live Feed.
2. Click Teams and click All Teams.
   - If you received an invitation, click Accept. You can Decline the invitation if you do not want to join the team.
   - If the team is public, click Join.
   - If the team is private, click Request. The team administrator receives an email notification and must accept your request before you can join the team.

**View a team feed**

View a team feed to see messages belonging to that team.

1. Navigate to Live Feed > Live Feed.
2. In the sidebar, click your profile picture, then select the Teams tab.
   - To view a team you belong to, select the team name.
   - To view a public team you do not belong to, select All Teams and then click the team name.
     You must be a member to view the feed for a private team.

**View a team member**

View a list of members belonging to a live feed team.

1. Navigate to Live Feed > Live Feed.
2. In the sidebar, click your profile picture, then select the Teams tab.
3. From the team list, select the team name.
   You must be a member of the team to view the members.
4. Click Members.
   The list of team members appears, organized by team administrators and team members.

**Invite a new member**

You can invite another user to join a team.

1. Navigate to Live Feed > Live Feed.
2. In the sidebar, click your profile picture, then select the Teams tab.
3. From the team list, select the team name.
4. Click the Pending members tab.
5. In the Add User field, enter the name of the user you want to invite. The invited member’s picture appears.

Remove a member

If you are team administrator, you can remove any member from the team.

1. Navigate to Live Feed > Live Feed.
2. In the sidebar, click your profile picture, then select the Teams tab.
3. From the team list, select the team name.
4. Click the **Members** tab.

5. Click **Remove** below the member name.

6. Click **Remove** again in the confirmation box that opens.

**Note:** You can remove members regardless of their current state. That is, you can remove members who have already joined the team or whose membership is pending.

---

**Subscribe to team and email notification**

Users can subscribe and unsubscribe to receive email notifications generated by feeds the team participates in.

Email notifications are generated whenever actions such as posting messages, replies, likes, polls, and @mentions are performed.

All notifications related to a top-level message, such as replies, mentions, and likes, are sent out with the same subject. The subject line defaults to **Live Feed** followed by the beginning of the subject line from the top-level message. For example, if the subject of the feed is **IT Support**, the email notification’s subject will be **Live Feed IT Support**.

1. Navigate to **Live Feed > Live Feed**.
2. Click **Teams** and select the team name.
3. Click the subscribe icon ( ).
You can click the unsubscribe icon ( suburbs ) to stop receiving email notifications.

**Subscribe a team to feed notification**
A team administrator can subscribe a team to specific feeds so the members of the team receive email notifications.

1. Navigate to **Live Feed > Live Feed**.
2. Click **Teams** and select the team name. You can use the advanced search to locate team of which you are the administrator.
3. Click **Feeds**.
4. Click the subscribe icon ( suburbs ) beside the feed name.

You can click the unsubscribe icon ( suburbs ) to stop receiving email notifications.

**Reply to email notifications using email**
After receiving an email about a posted message or a reply, you can reply to live feed with your email client.

The body of the reply email becomes a reply to the live feed message. Any attachments included in your reply email are included in the live feed reply.

**Leave a team**
You can give up membership to a team by leaving that team.

1. Navigate to **Live Feed > Live Feed**.
2. In the sidebar, click your profile picture, then select the **Teams** tab.
3. Click **Leave** beside the team name.

**Modify a team**
If you are team administrator, you can modify an existing team.

1. Navigate to **Live Feed > Live Feed**.
2. In the sidebar, click your profile picture, then select the **Teams** tab.
3. From the team list, select the team name.
4. Click the edit icon ( suburbs ).
5. Modify the team properties as needed.
6. Click **Save**.

**Manage a membership request**
When a user requests membership to a private team, the team administrator receives an email.

If you are the team administrator, you can manage membership requests.

1. Navigate to **Live Feed > Live Feed**.
2. Click **Teams** and select the team name.

If one or more users have been invited to the team, the **Pending members** tab shows the number of invitations sent.
Finance

Select members of finance group to discuss confidential information

Pending members
3. Click **Pending members**.
   This shows the users who have received invitations, but who have not yet accepted.

![Pending members](image)

4. You can cancel a user's invitation by clicking **Remove**.
5. You can invite another user to the team by entering their name in the **Add user** field and clicking the **Invite member** button.

**Delete a team**

If you are the team administrator, you can delete a team.

1. Navigate to **Live Feed > Live Feed**.
2. In the sidebar, click your profile picture, then select the **Teams** tab.
3. From the team list, select the team name.
4. Click the edit icon (ᵮ).
5. Click Delete.
6. Click Yes to confirm deletion.

The team is deleted from live feed. Messages posted to a private team are deleted; messages posted to a public team remain on the company feed without a team link.

If you delete a team that is associated with an active record, such as an incident that has not yet been closed, the team becomes active again when any user modifies that record or follows the record on live feed. The first user who modifies the record becomes the team administrator. The previous messages that existed as part of the record feed are not deleted.

**Use live feed to work on records**

A record feed is associated with a record, such as an incident or change.

Record feeds help users collaborate on records by providing a place for anyone who can access the record to share messages and post attachments specific to that record.

With record feeds, users can:

- Follow record feeds and post messages in live feed. These messages can also be automatically maintained in the comments or work notes journal fields on records.
- View live feed from records.
- Work on multiple records from My Feed.
- Access live feed team functions, such as sending invitations and subscribing to email notifications.

Any users with access to the record can also use the record feed. By default, record feeds are available on the incident, change, and problem tables. Administrators can configure record feeds for additional tables.
Live Feed Document

How Document Feeds Work

The Live Feed application creates a document group for each document feed. The document group:

- Automatically approves membership for every user who can access the record.
- Uses the record number as the group name.
- Uses the record short description as a group description.
• Maintains all messages posted on the record in live feed (if the record has a journal field for comments). When the group is created, existing messages are added to the document feed.
• Lists the group when users select View all groups on their live feed interface, unless the record associated with the document feed has been closed. When the state of the record is closed, the live feed group becomes inactive and unlisted.
• Automatically adds users to the document group when they view the record.

Document Group Creation

When a user follows or shows a record on live feed, a live feed group is automatically created and associated to the record (if one does not already exist). The user becomes a member of the group and can use live feed to work on the record. If the user can access work notes on the record, the user also becomes a group administrator.

A live feed group is also automatically created when a user creates a record on a table that uses document feeds, such as the Incident table. The user who creates the record becomes the administrator of the group, and any other user who modifies the same record automatically joins the group.

Add Live Feed to a homepage

Add live feed to a homepage so it is the first thing you see when you log in.

1. Click Add content at the top of the homepage.
2. Select Live Feed in the left panel.
3. On the bottom of the window, click **Add here** in the appropriate layout position, then close the window.

**Note:** Administrators can add live feed to a global homepage to make it available for all homepage users by default. By default, users with any role can add live feed to their homepage. Administrators can restrict this ability.

### Live Feed Homepage

#### Modifying and deleting document feeds

The user who creates a record feed becomes the group administrator, which allows the user to modify the following record feed properties.

- **Name:** default value is the record number.
- **Description:** default value is the record short description.
- **Picture:** default value is a thumbnail image of the record.
Feed administrators can also delete the feed. When deleted, the feed is removed from live feed but messages remain in the journal field of the associated record.

**Viewing Live Feed from records**

Interact with the record feed in any form that has live feed enabled.

The record feed appears in a pop-up window. The record feed also appears on the record form's activity formatter if the administrator enables the record feed system property (glide.ui.show_live_feed_activity).

To access a record feed from the form, do one of the following:

- Click the **Show Live Feed** button

  ![Show Live Feed button](image)

  in the form header. This displays the live feed pop-up.

- Right-click the form header and select **Show Live Feed**. This also displays the live feed pop-up.
• Scroll down to the activity formatter area on the form. Click one of the following tabs:
  • **Live Feed**: click to show a text box to type in the feed.
  • **Activity**: click to show the activity summary. The activity filter determines the content in the activity summary.

Live Feed Popup

If the activity formatter or the **Live Feed** and **Activity** tabs are not visible, administrators can do the following:
  • Configure the form layout and add **Activities (filtered)** to the form. This adds the activity formatter.
• Personalize the form layout and add **Activities (filtered)** to the form. This adds the activity formatter.
• Go to **System Definition > Tables**, access the table associated with the record, and verify that the live_feed dictionary attribute is set to true on the form. This adds live feed to the activity formatter.
• Go to **Live Feed > Feed Administration > Properties** and enable the following property: **Toggle the display of the live feed tab in the activity formatter**

**Working with record feeds**

When a user follows a record, the user becomes a member of a private group for the record.

Team members can:
• View the record feed from live feed.
• View a list of group members (other users who are following the record).
• Invite another user to join the group. Only users who have access to the record have access to the record feed.
• Subscribe to email notifications.
• Leave the team to stop following the record.

*Follow a record feed from a form*

You can follow records that have a record feed associated with them from within the record form.

1. Navigate to the record in a list or form.
2. Click the **Show on Live Feed** icon in the header.

---

**Follow Task**

*Follow a record feed from a list*

You can follow records that have a record feed associated with them when viewing a list of records. This method allows you to select multiple records to follow.

1. Navigate to a list of records (for example, **Assigned to me**).
2. Select the **Action** check box beside each record to follow.
3. In the **Actions** choice list, select **Follow on Live Feed**.

![Follow on Live Feed](image)

Follow My Tasks

*Post a message to a record feed*

Use live feed to post a message to a record feed.

1. Open the record feed in one of the following ways:
   - From your homepage (must already be following the record)
   - As a team in live feed (must already be following the record)
   - From My Live Feed (must already be following the record)
   - From the **Live Feed** pop-up window
   - From the **Live Feed** tab on the activity formatter
   - Click the **Show Live Feed** button

   ![Show Live Feed](image)

   in the form header.

2. Compose the message and add images and links.
3. [My Live Feed only] In the To list, select the record where you want to post the message.
4. [Optional] Select the **Work Notes** check box to post the message as a work note. Only users with access to work notes on the record can post and see work notes. This option is only available for records that have a journal field.
5. Click **Post**.

**Note:** If the record has journal fields for comments or work notes, your message is automatically added to the appropriate field on the record. If the record has a standard text field for comments on the activity formatter, each live post overwrites the field value. Comments added through live feed start with #LiveFeed on the activity formatter.

### Use feeds in Live Feed

Feeds allow users to create focused discussions in Live Feed.

Live feed includes different types of feeds. The user who creates a group or record feed becomes the feed administrator. This user configures the access level for the feed:

- **Public:** any user can see the name on the list of all feeds, view the feed, and join it. Messages appear on the company feed with a link to the public feed.
- **Private:** any user can see the name on the list of all feeds, but only invited members can view the feed and join. Messages do not appear on the company feed.

**Note:** The concept of groups has changed in live feed v2 (starting with the Fuji release).

### Create a group feed

Group feeds are created by users so that members with similar interests can find that information in one place. Individual users or teams can join group feeds.

1. Navigate to **Live Feed > Live Feed**.
2. Click **Group Feeds** and click **All Feeds**.
3. Click **Create Group Feed**.

![Create group feed](image)

4. Enter the feed name and description. These will appear in the list of group feeds.
5. Indicate how members can join the feed:
- **Public Feed**: Select this to allow anyone to view and join the group feed.
- **Private Feed**: Select this to restrict membership to only members invited by the administrator.

  When **Private Feed** is selected, the **Show this feed for anyone to find and request to join** check box is displayed. If it is selected, any user can search for this group feed and join it. If the check box is not selected, only users who are invited can see the feed and join the group feed.

6. Click **Create**.

### Create record feeds

When a user views a record on a table that has live feed enabled, such as the **Incident** table, the user can click the **Show live feed** button at the top of the form to automatically create a record feed.

When a user who has write access to a record's **work_notes** journal field clicks the **Show live feed** button, that user becomes the record feed administrator. If, for example, a customer calls technical support to report an incident and the customer clicks **Show live feed** on a record, a record feed is created, but the customer is not the record feed administrator. When a support representative later opens the incident and participates in the record feed, the user becomes the feed administrator.

Record feeds are, by default, private unlisted. That is, only invited members can see the name of the record feed in the list of feeds, and join it. Record feed administrators, however, have the ability to change the access level at any time. This can be helpful if, for example, a user is working on a sales opportunity and wants customers to be able to participate in a record feed without granting them access to the records.

### Control how live feed is enabled for records

A property called **glide.ui.show_live-feed_activity** controls whether live feed is automatically enabled for all records.

This glide record is disabled by default. If the property is enabled, a record feed is automatically created whenever a record is viewed, and you become a member of that feed.

A second property, **glide.live-feed.auto_join_document_group**, enables automatic membership to a record feed whenever the associated document is visited and the user clicks **Show Live Feed**.

### View the activity stream in record feeds

When you view record feeds, live feed displays the activity stream for the document.

For example, for an incident feed, the screen displays recent activity for the incident. The activity stream is updated whenever anything is changed in the associated record.
Live feed activity stream

Note: The information in the activity stream is subject to the same ACL rules as those for viewing the underlying document.
Participate in a feed

When you join a feed, you become a feed member.

Feed members can:

• View messages posted to the feed. Non-members can also view the messages for a public feed.
• View a list of feed members.
• Invite another user to join the feed.
• Subscribe to feed email notifications.
• Leave the feed.

1. Navigate to Live Feed > Live Feed.
2. Click either **Group Feeds** or **Record Feeds**, and then click **All Feeds**.

- If you received an invitation, click **Accept**. You can **Decline** the invitation if you do not want to join the feed.
- If the feed is public, click **Join**.
- If the feed is private, click **Request**. The feed administrator receives an email notification and must accept your request before you can join the feed.

**Mark a feed as a favorite**

Top-level messages in feeds can be marked as favorites on a per user basis only.
You can also search for messages marked as favorites, and remove the favorite designation as needed.

1. Navigate to **Live Feed > Live Feed**.
2. Click either **Group Feeds** or **Record Feeds**, and then click **All Feeds**.
3. In the list of feeds, click the star icon (⭐) adjacent to the feed name you want to mark as a favorite.

   To unfavorite a message, click the star icon (⭐) of a message that is already a favorite.

**View a feed**

You have several options for viewing a feed.

1. Navigate to **Live Feed > Live Feed**.
2. Click either **Group Feeds** or **Record Feeds**.
    - This displays a list of feeds you belong to and an option to view all feeds.
    - To view a feed you belong to, select the feed name.
    - To view a public feed you do not belong to, select **Show All** and then click the feed name. You must be a member to view the feed for a private feed.

   **Note:** If you navigate away from the live feed application and then back again, the system displays the feed you last visited if you are a member of it.

**View a feed member**

View a specific member of a group feed.

1. Navigate to **Live Feed > Live Feed**.
2. Click either **Group Feeds** or **Record Feeds**.
   - This displays a list of feeds you belong to and an option to view all feeds.
3. Click the feed name.
   - The list of feed members appears, organized by feed administrators and members.

**Invite a new member to a group feed**

The feed administrator can invite another user or a group to join a feed.

When a team is added to a feed, all members of the team also indirectly become members of the feed. Only users, and not teams, can be the feed administrators. A team member who is following a feed can become administrator by directly inviting another user to the feed.

1. Navigate to **Live Feed > Live Feed**.
2. Click either **Group Feeds** or **Record Feeds**, and then select the feed name.
3. Click the **Pending members** tab.
4. In the **Add user or team** field, begin entering a user or team name and select a user or team from the suggestion list.
   - The invited user or team members receive an email notification.

**Invite a new member to a record feed**

The feed administrator can invite another user or a team to join a record feed.

When a team is added, each of the individual members of the team become members of the feed. That is, if Team ABC is added to a feed, the feed does not show that Team ABC is a member. Instead, the feed shows each of the individual members of Team ABC as members of the feed.
When users are invited, their membership state is initially **Invited**. When they accept the invitation, the system checks their access to the **work_notes** journal field. If they have write access, they become administrator members; otherwise, they become active members.

1. Navigate to **Live Feed > Live Feed**.
2. Click **Record Feeds** and select the record feed name.
3. Click the **Pending members** tab.
4. In the **Add user or team** field, begin entering a user or team name and select a user or team from the suggestion list.

   If you invite a team, the individual members of the team are invited.

   The invited users receive an email notification.

---

**Remove a member from a feed**

The feed administrator can remove any member from the feed.

1. Navigate to **Live Feed > Live Feed**.
2. Click either **Group Feeds** or **Record Feeds**, and then select the feed name.
3. Click the **Members** tab.
4. Locate the member you want to remove and click **Remove**.

![Remove member](image)

**Note:** You can remove members regardless of their current state. That is, you can remove members who have already joined the feed or whose membership is pending.

**Subscribe to a feed**

Direct members of a feed can subscribe and unsubscribe to the feed in order to receive email notifications whenever any activity in the feed occurs, such as new messages being posted, replies, likes, polls, and @mentions.

Individual indirect members—that is, members of a team that is participating in a feed—cannot subscribe or unsubscribe from a feed directly. If the team administrator subscribes the team to a feed, the individual members receive an email notification for activities in the feed such as new messages being posted, replies, likes, polls and @mentions.

All notifications related to a top-level message, such as replies, mentions, and likes, are sent out with the same subject. The subject line defaults to **Live Feed** followed by the beginning of the subject line from the top-level message. For example, if the subject of the feed is **IT Support**, the email notification's subject will be **Live Feed IT Support**.

1. Navigate to **Live Feed > Live Feed**.
2. Click either **Group Feeds** or **Record Feeds**, and then select the feed name.
3. Click the subscribe icon ( ).

You can click the unsubscribe icon ( ) to stop receiving email notifications.

**Note:** If a team is subscribed to receive email notifications for a feed, but a member of the team did not subscribe to the team, that member does not receive the email notifications.

**Navigate between live feed and other modules**

If you are participating in a feed and navigate to another module, when you return to live feed it displays the feed you were previously viewing if it is public or if it is a private feed that you are a member of.

For example, assume you are viewing a public feed and then navigate to a particular incident record. Upon returning to live feed, the feed you were previously viewing opens. If you were last viewing a private feed that you are not a member of, returning to live feed opens the Company Feed.

**Leave a feed**

Members can choose to leave a group feed.

1. Navigate to Live Feed > Live Feed.
2. Click either Group Feeds or Record Feeds, and then select the feed name.
3. Click Leave.

**Note:** If you leave a feed associated with a record, such as an incident, you automatically rejoin that feed if you modify the associated record again.

**Delete a feed**

If you are a feed administrator, you can delete the feed.

1. Navigate to Live Feed > Live Feed.
2. Click either Group Feeds or Record Feeds, and then select the feed name.
3. Click Delete.
4. Click Yes to confirm deletion.

The feed is deleted from live feed. Messages posted to a private feed are deleted. Messages posted to a public feed remain on the Company Feed without a feed link.

**Live Feed UI overview**

The Live Feed user interface provides many methods you can use to share content with others in your organization.

**Update your Live Feed profile**

Your profile information includes a photo or image, and tabs for different types of information including messages, feeds, teams, followers, and those who are following you. You can update your profile information and picture at any time.

**Note:** The functionality described here applies to HTML5-compliant browsers, such as Chrome, Firefox, Safari and IE10 and above.

1. Navigate to Live Feed > Live Feed.
2. Click your name or title displayed below your picture.

Profile record opens.

3. Click the pencil icon next to About Me and type a short description about yourself that you want to share with others who view your profile. This is text that you might not necessarily want to change on a regular basis.
4. You can change your profile photo using either of the following two methods:
   - Locate the photo file you want to use, and drag-and-drop it over the existing photo.
   - Hover over the existing picture (or tap the photo in the case of the smartphone or tablet interface) to display the **Upload a picture** link. Click the link, navigate to the location of the photo you want to use, and click **Open**.

![Upload a picture](image)

**Note:** Your profile picture is used by the Connect and legacy chat features as well if they are activated.

**Work with Live Feed messages**

This portion of the UI gives the user access to various types of messages and tools for grouping and categorizing messages. Also included are methods for identifying which user feeds you are following and which users are following you.
Tools for working with live feed messages

<table>
<thead>
<tr>
<th>Menu section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Live Feeds</td>
<td>These are custom feeds that allow you to customize live feed to view the content that is most important to you.</td>
</tr>
<tr>
<td>Company Feed</td>
<td>This feed displays all posts, except those posted to private or unlisted groups.</td>
</tr>
<tr>
<td>Group Feeds</td>
<td>These feeds are created by users. Record Feeds: These feeds are associated with a record, such as an incident or change.</td>
</tr>
<tr>
<td>Record Feeds</td>
<td>These feeds help users collaborate on records by providing a place for anyone who can access the record to share messages and post attachments specific to that record.</td>
</tr>
<tr>
<td>People</td>
<td>This option displays people who are following the current user and people the current user is following.</td>
</tr>
<tr>
<td>Teams</td>
<td>This option is used to combine users into groups for the purpose of subscribing to specifically-focused conversations.</td>
</tr>
<tr>
<td>Hashtags</td>
<td>Hashtags are words marked with a hash (#) symbol in messages. Hashtags are used to categorize messages by keyword or topic for improved search results messages filtered from all conversations that include specific hashtags.</td>
</tr>
</tbody>
</table>

View another Live Feed user

When a requester user, one that has no ServiceNow role, is viewing a feed and points to another user's picture, information for the user appears from the Business Card view of the User [sys_user] table.

You can customize ACLs to increase the amount of information you want displayed for users with different roles.
View profile

If you click a user’s name or title, the user’s profile appears. Click the tabs to view different types of information for the user.
Follow other Live Feed users

As you use Live Feed, you can follow the message threads of other users.

1. Navigate to a thread that the user you want to follow is engaged in.
2. Click that user's name or point to the user's picture. 
   A **Follow** link appears in the user's profile.

![Profile with Follow link](image)

3. Click **Follow**.
4. To stop following the user, navigate to **People > Following**.

5. Click **Unfollow**.

6. To view people who are following you, navigate to **People > Followers**.
Select feeds

A feed is a stream of related messages. You can use the feed selector to switch between feed types and to view specific group feeds and record feeds.

1. Use the Search field to locate any type of feed. As you type in the Search field, the results are dynamically displayed. For example, if you type INC, records that are incidents are forced to the top of the results list.
2. You can also select the following types of feed information.

### Feeds types

<table>
<thead>
<tr>
<th>Feed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Live Feeds</td>
<td>Displays the following posts:</td>
</tr>
<tr>
<td></td>
<td>• messages from users you follow</td>
</tr>
<tr>
<td></td>
<td>• messages with hashtags you follow</td>
</tr>
<tr>
<td>Company Feed</td>
<td>Displays all posts, except those posted to private or unlisted groups.</td>
</tr>
<tr>
<td>Add Group Feed</td>
<td>Allows you to add a group feed.</td>
</tr>
</tbody>
</table>

### Follow feeds

You can view users who are following you or other users you are following.

To view users who are following you or other users you are following, click **People** in the sidebar.

The system shows 10 most recent followers or users you are following.

**People**

If either list contains more than 10 users, a Show More link appears.

**Note:** If you are following a particular user whose profile changes, that user moves to the front of the Following list. This alerts you to changes in the profile of a user you are following.
**Bookmark feeds and hashtags**

The live feed interface uses the standard bookmarking functionality for feeds and hashtags. In UI15, you can drag-and-drop group feeds and hashtags from the Feed Summary section to the Edge for quick access.

![Feed Interface Screenshot](image)

**Bookmark a hashtag**

**Add Live Feed to your homepage**

You can add Live Feed to your own homepage or to a global homepage.

1. Navigate to a homepage.
2. Click the add content icon ( ) in top left corner of the homepage.
3. Select Live Feed in the left panel.
4. On the bottom of the window, click **Add here** in the appropriate layout position, then close the window.
Note: Administrators can add live feed to a global homepage to make it available for all homepage users by default. Users with any role can add live feed to their homepage; however, administrators can restrict this ability.

Post content in Live Feed

In Live Feed, you can post new messages and replies to existing messages for all users in the feed. You can also send a reply message to a team or record.

Post a live feed message

You can post a message to open a new feed.

1. Navigate to Live Feed > Live Feed.
2. Click the feed to which you want to post your message, for example My Live Feed, Company Feed, and so on.
3. Enter a message in the Share your thoughts field. Use hashtags, if you want.
4. As needed, click , , or to add a poll, attachment, or screenshot image, respectively.
5. Click Post.

Reply to a live feed message

To participate in an existing thread of a feed, you can compose and submit a reply message. By default, the message is visible to all members of the feed.

1. Navigate to Live Feed > Live Feed.
2. Locate the message you want to reply to.
3. Type your reply in the message box and click Reply.
   As needed, you can add hashtags, attachments, links, or knowledge base articles.
4. To limit who can view the reply to a single individual, select a user from the To choice list.
5. Click Reply.
6. By default, 7 replies are visible for each message. To view additional replies, click Show all replies. Any reply to a reply includes a Threads link.
7. Click **Threads** to view all of the replies within the selected reply in reverse chronological order within the **Message Thread** pop-up window, similar to an email thread.
Message Thread

Navakanth Reddy #suggestion(s) A common black vertical line just before the bars would help with this. Also, line spacing between two options should be more than single-spaced.

Also, the bar says 5 people voted and it shows up 5 people and 1 more. Is this a #bug?

8 days ago • in reply to Nirupam Biswas • Like (1) • Reply • Share • Tags (2)

Nirupam Biswas I guess we need some visual distinction between the poll question and the options. After voting, I got confused for some moments why there are four options in result. See screenshot.

8 days ago • Like (1) • Reply • Share • Tags

Shouvik Goswami We have enabled polls in Live Feed. Please review and provide #suggestions and #feedbacks

How do you like the poll in Live Feed?

- Exactly what I was looking for
- Wanted something more
- Didn't visualize it this way

8 days ago • Like (1) • Reply • Share • Tags (2)
Attach files, links, images, and knowledge articles to messages

In addition to entering text, you can attach files, such as images, documents, and spreadsheet files in any ServiceNow supported file type to live feed messages.

Administrators can manage attachment file settings, such as supported file types and maximum attachment file size, by editing system properties.

You can also include links to user-defined URLs and knowledge articles contained in your instance's knowledge base.

Note: The functionality described here applies to HTML5-compliant browsers, such as Chrome, Firefox, Safari and Internet Explorer 10 and above. Significant differences while using different browsers are highlighted.

Attach a file to a post or reply

You can attach files to a post by dragging a file into a post or pasting an image from the clipboard.

Use the paperclip icon ( ) to drag files into a post. Additionally, you can paste images into a post or reply from the clipboard.

1. Do one of the following:
   • While composing a post or reply (see Reply to a Message), locate one or more images or other supported types of files, and drag them into the message box.
   • Click the paperclip icon in the message box, navigate to the location of the files you want to attach, select them, and click Open.
2. To add more files, drag-and-drop additional files into the text box below the displayed files or images, or click the plus sign.

3. If you want to delete an attachment before posting the message, click the trashcan icon adjacent to the attachment.

4. Enter a comment to share your thoughts about the image.

   **Note:** The **Post** button is enabled only after you add the comment.

5. Click **Post** or **Reply**.
6. If you added files that do not contain previews and then posted the message, they will be listed in the message box with a **Download** link.
7. Click the link to download the files.

Copy an image from the clipboard

In addition to adding files to a message, you can also copy images to the clipboard and paste them into a message or reply.

1. Click into the **Comment** box and add a comment.

   ![Comment box](image)

   Here is how to drag-and-drop tags in order to bookmark them.

   

   

   ![Comment box](image)

   Copy paste

2. Click the **Add an image** button.
   The **Screenshots** dialog box opens.

   ![Screenshots dialog box](image)
3. Right-click the **Paste an image here** box and select **Paste** to paste the image from the clipboard.

4. To add another image, repeat the previous steps.
5. When you finish pasting images into the message, click **Done**.
6. To change the link text, click **Pasted Image** and enter a new label.
7. When you finish, click **Post** or **Reply**.
8. To remove an image, click the trash can icon adjacent to the link.
9. To make changes to an existing image, click the edit icon (📝).

**Note:** The copy/paste functionality is supported in Chrome, Firefox, and Internet Explorer 11.

---

**Add a link to a post or reply**

Add or modify a link to a live feed post.

1. Click into the **Comment** box. The **Add a link** button appears.
2. Click the **Add a link** button. The **URL** and **Link text** fields appear.

![Add a link to a post or reply](image)

---

**Add a URL**

3. Enter the URL and the text you want to appear as the link.
4. To add another link, click the link icon under the **URL** field.
5. When you have finished entering your message, click **Post** or **Reply**.

![Comment](image1)

**URL Saved**

To remove a link, click the trash can icon adjacent to the link. To make changes to an existing link, click the edit (✏️) icon.

**Add a knowledge article link to a post or reply**

Use the ID of a knowledge article to post it as a reply to a live feed conversation.

1. While composing a post or reply, type the ID of the knowledge article you want to link to. You do not need to identify the knowledge article ID as a hyperlink; live feed recognizes it as such and automatically converts it into a link when the message is posted.
2. When you are finished entering your message, click **Post** or **Reply**.

![Comment](image2)

**KB link**
Add a poll to a message

When you are posting a message, you have the option of creating a poll in order to record your viewers' opinions. As users take the poll, their feedback statistics are displayed within the feed.

1. Open the feed where you want to create a message with a poll.
2. Enter the message with an invitation to take the poll in the Share your thoughts box.
3. Click the poll icon.

4. In the Question field, enter the question on which you are soliciting opinions.
5. In the Option fields, enter possible responses to the query.
6. To add more response options, click Add more options.
7. **Click Post.**
   After the poll is posted, users who view the message can vote. After they vote, their pictures appear next to their response, with others who have voted for the same option.

   **Note:** Only the poll creator can view results without casting a vote. Other members can see results only after casting a vote or if the poll is closed.

   ![Poll Example]

   **Close poll**

   An email notification with the poll result is sent to all participants of the poll informing them that the poll is closed.

   **Add mentions to a message**

   An @mention is any posted update that contains @username anywhere in the body of the message. The user's name, with a link to that user's feed, is inserted into the message. Additionally, the mentioned user receives an email notification about the mention. This is a great way of bringing attention to other members in a conversation. All @mentions are included in the logged-in user's My Feed.
Note: If an @mention is used by a member of a team, only members of that team appear in the auto-suggest list.

1. While entering a message or reply in a conversation, type `@username` anywhere in the message. As you type, an auto-suggest list appears with names and pictures of users that match your entries. For example, if you type `@t`, the auto-suggest list shows the pictures and names of all users with names that start with T.

2. Click the user you want to add.
That user's name is inserted into the @mention in the body of the message.

Note: My Feed displays @mentions of you and the teams you are a member of. Profile feeds for another user display only @mentions of that user.

Like a message

Like a message to provide feedback to the author.

1. Navigate to Live Feed > Live Feed.
2. Click Feeds.
3. Locate the feed that contains the message you want to like.
4. Under the message title, click Like.

If the message has previously been liked, the number of likes for a message displays next to the Like link.

For a top-level message, the profile pictures of the first 5 users who liked a message are displayed. Any additional users who liked the message can be viewed by hovering over the #more link. If the logged-in user has liked the message, that user's image will appear first, followed by the image of the user who last liked the message.

For a reply, you must hover your mouse pointer over the count link to view the users who liked the message.
**Delete a message**

Users can delete any of their own posts or replies. A conversation administrator can also delete messages.

1. Hover over the message you want to delete.
2. Click the trash can icon in the upper-right-hand corner of the message box.
3. Click **Delete** in the confirmation box.

The message disappears from the feed.

---

**Managed Documents**

Use the ServiceNow® Managed Documents application to control electronic documents within your instance.

After parameters have been set by the administrator and the Knowledge Document plugin installed, documents can move through the managed document cycle.

*Note:* Step through the process below on your test (or any non-production) instance.

---

**Managed Document features**

Managed Documents is a lightweight, ITIL-based solution for creating and managing electronic documents within your instance.

This application adds a layer of control around any document by providing workflow, storage, security, and categorization options. It can be used for a variety of internal documents, such as policies and procedures, compliance documentation, and knowledge articles. Because it is integrated within the instance, Managed Documents offers a seamless alternative to 3rd-party systems.

**Features**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check-in/Check-out</td>
<td>Track revisions, approval history, and automated notifications for approvers and reviewers. Useful for compliance and risk authors, policy and procedure writers, and contract administrators.</td>
</tr>
<tr>
<td>Categorization</td>
<td>Classify documents for organization and search.</td>
</tr>
<tr>
<td>Access control</td>
<td>Share documents with selected users.</td>
</tr>
<tr>
<td>Revision control</td>
<td>Track changes to documents.</td>
</tr>
<tr>
<td>Digital signature for approval</td>
<td>Integration with the Approval with E-Signature plugin.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Support consistent content review and approval.</td>
</tr>
<tr>
<td>Security</td>
<td>Use high security setting.</td>
</tr>
</tbody>
</table>
## Managed Document concepts

The following concepts explain Managed Documents: Managed Document, Document Collection, Document Revisions, and Document Parameters.

<table>
<thead>
<tr>
<th>Concept</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managed Document</td>
<td>The Document [dms_document] table contains the documents controlled through the managed documents process.</td>
</tr>
<tr>
<td>Document Collection</td>
<td>The Document Collection [dms_collection] table allows related documents to be grouped together.</td>
</tr>
<tr>
<td>Document Revisions</td>
<td>Because managed documents must have clear records of individual versions of a document, revisions (including the file) are attached to the master document record through a related list. Document revisions are controlled to keep a standard naming scheme and consistent version numbers. Once a document revision is ready, it can be submitted for review.</td>
</tr>
<tr>
<td>Document Parameters</td>
<td><strong>Attention:</strong> Parameters do not control application or document security. Parameters only organize documents, they do not affect who can access documents. To grant access to the Managed Documents application, you can assign a role. To grant access to a specific document, set user and group permissions. Each document can be associated with predefined parameters. The parameters can help with grouping documents.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Defines the type of document being controlled. Documents of the same type use the same controls.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Classification:</strong> Defines document restriction level, such as public, restricted, or confidential.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Audience:</strong> Defines the groups with access to the document, such as internal or external.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Name Formats:</strong> Defines the format of document names, ensuring that documents of the same type have the same name scheme assembled from name components.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Name Components:</strong> Defines the document values used in the name formats.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Approval Rules:</strong> Defines the approvals the document must have before it can be published.</td>
</tr>
</tbody>
</table>
**Install the Managed Documents plugin**

The Managed Documents plugin is available for activation by users with the admin role.

1. **Navigate to System Definition > Plugins.**
2. **Right-click the plugin name on the list and select Activate/Upgrade.**
   
   If the plugin depends on other plugins, these plugins and their activation status are listed.
3. **[Optional] Select the Load demo data check box.**
   
   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when first activating the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. **Click Activate.**

**Managed Documents plugin**

This page describes the applications and modules, database table structure, scripts, and roles.

**Database table structure**

The following tables are added:

<table>
<thead>
<tr>
<th>Display Name (Table Name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revision [dms_revision]</td>
<td>The document revisions.</td>
</tr>
<tr>
<td>Classifications [classification]</td>
<td>The document restriction level, such as public or confidential. (Does not define access to the document. Document security is set in user and group permissions.)</td>
</tr>
<tr>
<td>Type [dms_type]</td>
<td>The document purpose.</td>
</tr>
<tr>
<td>Component [dms_component]</td>
<td>The components of name formats. The value field is a dot-walking expression that is evaluated. An exception is made for the revision because it does not exist when the revision name is generated.</td>
</tr>
<tr>
<td>Name format [dms_name_format]</td>
<td>The composition of components to generate revision names.</td>
</tr>
<tr>
<td>Approval sequence [approval_sequence]</td>
<td>The approval sequences that users need to follow.</td>
</tr>
<tr>
<td>Approval Rule [dms_approval_rule]</td>
<td>The criteria that records of the dms_document table must match. Used to automatically add approvers to a document.</td>
</tr>
<tr>
<td>Collection [dms_collection]</td>
<td>The document groups created by the user.</td>
</tr>
</tbody>
</table>
Scripts

Business rules that are added to sys_script

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Document</td>
<td>Changes the state of a document depending on its revisions.</td>
</tr>
<tr>
<td>Add Approvers</td>
<td>Populates the list of approvers in the document.</td>
</tr>
</tbody>
</table>

Script includes that will be added to sys_script_include

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DocumentManagement</td>
<td>Contains the main logics for the Managed Documents plugin.</td>
</tr>
<tr>
<td>DocumentManagementDB</td>
<td>Contains methods to perform CRUD operations on the database.</td>
</tr>
<tr>
<td>DocumentManagementSecurity</td>
<td>Helps manage the security of the Managed Documents system.</td>
</tr>
<tr>
<td>DocumentManagementAjax</td>
<td>Updates the details of the temporary revision that is created when opening the upload/check in revision form.</td>
</tr>
<tr>
<td>DocumentAttachmentAjax</td>
<td>Renames an attachment file.</td>
</tr>
<tr>
<td>DocumentRevisionWorkflowHelper</td>
<td>Helps perform basic workflow operations on a revision.</td>
</tr>
<tr>
<td>DocumentManagementApprovalMatcher</td>
<td>Helps obtain the user and group approvers for a document that matches approval rules.</td>
</tr>
<tr>
<td>DocumentApproverHelper</td>
<td>Contains logics to handle document approvers.</td>
</tr>
<tr>
<td>DocumentManagementUtils</td>
<td>Useful methods.</td>
</tr>
<tr>
<td>DocumentReferenceQualifiers</td>
<td>Static methods that return reference qualifiers.</td>
</tr>
</tbody>
</table>

Client script that is added to sys_script_client

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document type change</td>
<td>Updates the name format field in the revision settings section of the document. Each type has a default name format.</td>
</tr>
</tbody>
</table>

Roles

This plugin introduces two new roles:
Roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>document_management_user</td>
<td>This role enables a user to access the Managed Documents plugin, create documents, and search for documents. Document reviewers and approvers need the document_management_user role to access the Managed Document plugin. (Please note that reviewers and approvers can also access a document revision from an approval record.)</td>
</tr>
<tr>
<td>document_management_admin</td>
<td>This role enables a user to change administrative settings for the Managed Documents plugin.</td>
</tr>
</tbody>
</table>

**Note:** Each document has individual permissions, so even if a user is given the document_management_user role and has permissions to the application, the user can only view documents to which they have been given access.

Create a new managed document record

Configure the properties and policies for a managed document.

1. Navigate to Managed Documents > Create New.
2. In the Name field, type Policy.
3. In the Requested by field, add your name.
4. In the Owner field, add your name.
5. In the Reviewer field, add your name.
6. In the Type field, select Policy.
7. In the Classification field, select Confidential.
8. In the Audience field, select Internal.
9. Under Revision Settings, select the Auto increment revision option.

10. Click Submit.
Check in a document after making changes

After making changes to a document, check the revised document into Managed Documents.

1. Open the document record.
2. Click the **Upload/Check in Revision** related link.
3. Click **Choose File**, select the revised file, and click **Open**.
4. Check that the **Name** and **Revision Number** contain the updated number.
5. Ensure that the **Check in** option is selected.
6. Click **OK**.

The Document Revisions list updates to contain the most recent revision.

```
<table>
<thead>
<tr>
<th>Name</th>
<th>Revision number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy_POL_0.1</td>
<td>0.1</td>
</tr>
<tr>
<td>Policy_POL_0.2</td>
<td>0.2</td>
</tr>
</tbody>
</table>
```

Check out a document to make changes

After a document is added to a managed document record, check the file out to make changes. Checking documents in and out keeps a record of document changes and ensures that only one person at a time is editing the document.

1. Open the document record.
2. Select the **Check Out Document** related link.
3. Select **Download file**.
4. Click **Check Out**.
5. Open the file and make a small change.
6. Save the document with the same name, but a new revision number. For example, **Policy_POL_02.txt**.
Publish a document in Managed Documents

After the document is reviewed and approved, publish the document within Managed Documents.

1. Open the document record.
2. In the Document Revisions list, click the name of the revision that was approved and is listed in the Ready for Publishing stage.
3. In the header bar, click **Publish Revision**.

4. In the Publish revision dialog box, check that the name and revision number are correct and click **Publish**.
   In the Document Revisions list, the revision you just published is now in the Published stage.

Send a document out for review and approval

When a document is ready, send it out for review and approval. If a reviewer or approver is not identified in the document record, the document is moved directly to the publishing stage.

1. In the Document Revisions list, right-click the revised document and select **Submit Revision**.

Because you identified yourself as the reviewer, you receive an approve request email message.

2. In the email message, click the link next to **Click here to view Approval Request**.
3. (Optional) View the document by clicking the attachment name under **Document Revision**.
4. Click **Approve**.
   The Approvals page displays and lists the document you just approved.
5. Open the document record.
6. In the Document Revisions list, the revision you approved is now in the Ready for Publishing stage.
**Upload a document as an attachment**

After creating a document record, add the document to the record as an attachment.

1. Open the document record.
2. Select the **Upload/Check in Revision** related link.
3. Click **Choose File**.
4. Select a simple document, such as a text file, and click **Open**.
5. Check that the name reads **Policy_POL_0.1**.
6. Click **OK**.

The document is listed under Document Revisions.

**Defining Document Parameters**

Before using the Managed Documents application, the user with the `document_management_admin` role needs to set the parameters that define the kinds of documents to be managed through the application. Managed Documents provides both base and custom parameter options.

**Defining Document Parameters**

The following document parameters should be defined:

- **Type**: identifies the purpose of the document. The type also determines the default document format and name format.
- **Classification**: indicates the security level assigned to the document and determines who can view or edit the document.
- **Audience**: specifies the intended readers of the document.
- **Name format**: specifies the name format to use when a document revision is added.
- **Name components**: are individual identifiers used inside a name format. Name components define a reference path (often by dot-walking) that holds the value specific to the document.
- **Approval rules**: determine which approvers are added to documents (in addition to the Reviewers specified on the document record).

**Defining Types**

To define a new type, navigate to **Managed Documents > Administration > Type** and click **New**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the type.</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>A short code for the type. Referenced as a name component for the name format.</td>
</tr>
<tr>
<td>Label</td>
<td>A label to display in the <strong>Type</strong> choice list.</td>
</tr>
<tr>
<td>Name Format</td>
<td>The name format that documents of this type will use.</td>
</tr>
<tr>
<td>Order</td>
<td>A number indicating the type’s sequence in the choice list.</td>
</tr>
</tbody>
</table>

The following types are available in the base system.

<table>
<thead>
<tr>
<th>Name</th>
<th>Code</th>
<th>Label</th>
<th>Name format</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>-- None --</td>
<td>null</td>
<td>-- None --</td>
<td>null</td>
<td>1</td>
</tr>
<tr>
<td>policy</td>
<td>POL</td>
<td>Policy</td>
<td>Default Policy</td>
<td>2</td>
</tr>
<tr>
<td>guideline</td>
<td>GUI</td>
<td>Guideline</td>
<td>Default</td>
<td>3</td>
</tr>
<tr>
<td>procedure</td>
<td>PROC</td>
<td>Procedure</td>
<td>Default</td>
<td>4</td>
</tr>
<tr>
<td>contract</td>
<td>CON</td>
<td>Contract</td>
<td>Default</td>
<td>5</td>
</tr>
</tbody>
</table>

**Note:** For documents with a **Type** of **Contract**, a **Contracts** related list appears on the document record, listing any contracts the document is associated with.

### Defining Approval Rules

To define a new approval rule, navigate to **Managed Documents > Administration > Approval Rules** and click **New**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique identifier for the approval rule.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box indicating whether this approval rule is used.</td>
</tr>
<tr>
<td>Condition</td>
<td>A condition builder that determines which documents use this approval rule.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description of the approval rule.</td>
</tr>
</tbody>
</table>

Once the approval rule is saved, the **Approvers** related list defines which approvers are added if the conditions in the **Condition** field are met.

The following approval rules are available in the base system.

<table>
<thead>
<tr>
<th>Name</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal policy</td>
<td>type=Policy ^ audience=Internal</td>
</tr>
<tr>
<td>Development policy</td>
<td>type=Policy ^ department=Development</td>
</tr>
</tbody>
</table>
Defining Audiences

To define a new audience, navigate to Managed Documents > Administration > Audience and click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audience Name</td>
<td>A unique name for the audience.</td>
</tr>
<tr>
<td>Audience Code</td>
<td>A short code for the audience. Referenced as a name component for the name format.</td>
</tr>
<tr>
<td>Label</td>
<td>A label to display in the Audience choice list.</td>
</tr>
<tr>
<td>Order</td>
<td>A number indicating this audience's sequence in the choice list.</td>
</tr>
</tbody>
</table>

The following audiences are available in the base system.

<table>
<thead>
<tr>
<th>Audience</th>
<th>Audience code</th>
<th>Label</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>internal</td>
<td>INT</td>
<td>Internal</td>
<td>1</td>
</tr>
<tr>
<td>external</td>
<td>EXT</td>
<td>External</td>
<td>2</td>
</tr>
</tbody>
</table>

Defining Classifications

Define a new classification on the Classification form.

Navigate to Managed Documents > Administration > Classification and click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the classification.</td>
</tr>
<tr>
<td>Code</td>
<td>A short code for the classification. Referenced as a name component for the name format.</td>
</tr>
<tr>
<td>Label</td>
<td>A label to display in the Classification choice list.</td>
</tr>
<tr>
<td>Order</td>
<td>A number indicating this classification's sequence in the choice list.</td>
</tr>
</tbody>
</table>

The following classifications are available in the base system.

<table>
<thead>
<tr>
<th>Name</th>
<th>Code</th>
<th>Label</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>public</td>
<td>P</td>
<td>Public</td>
<td>1</td>
</tr>
<tr>
<td>restricted</td>
<td>R</td>
<td>Restricted</td>
<td>2</td>
</tr>
<tr>
<td>confidential</td>
<td>C</td>
<td>Confidential</td>
<td>3</td>
</tr>
</tbody>
</table>

Defining Name Components

Name components define the document values used in the name format.

For example, the name component document.audience.code dot-walks from the document record to the audience Code.
To define a new name component, navigate to Managed Documents > Administration > Components and click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique identifier for the name component.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A short description of the name component value.</td>
</tr>
</tbody>
</table>
| Value         | The path to the field holding the value used for the name format. Defined relative to a current revision record. For example:  
- Enter revision to use the revision Number field on the revision record.  
- Enter document.name to use the Name field on the revision’s referenced document.  
- Enter document.audience.code to use the Code field for the audience referenced by the document.  
This dot-walking approach makes it possible to get any value related to the revision into the name format. |

**Note:** The revision component is a special component replaced by the appropriate revision number (rather than querying a value related to the current record). The revision is either automatically incremented or uses the latest revision number, depending on the setting on the document form.

The following components are defined in the base system.

<table>
<thead>
<tr>
<th>Name</th>
<th>Short description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audience code</td>
<td>Displays the code assigned to the document audience.</td>
<td>document.audience.code</td>
</tr>
<tr>
<td>Classification code</td>
<td>Displays the classification code.</td>
<td>document.classification.code</td>
</tr>
<tr>
<td>Document name</td>
<td>Displays the document name.</td>
<td>document.name</td>
</tr>
<tr>
<td>Revision</td>
<td>Displays the document revision.</td>
<td>revision</td>
</tr>
<tr>
<td>Type code</td>
<td>Displays the code assigned to the document type.</td>
<td>document.type.code</td>
</tr>
</tbody>
</table>

**Defining Name Formats**

The name format automatically generates a name for a document revision by arranging name components in a standard code to match naming conventions.

For example, a name format with the name components Type Code, Document Name, and Revision Number and the separator -, would be formatted as:

```
TYPECODE-Name-RevNumber.fileformat
```

In this example, a policy (code POL) named IT Off-Boarding Policy, with revision number 1.0, and uploaded as a .docx file would have the name:
To define a new name format, navigate to Managed Documents > Administration > Name Formats and click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the name format.</td>
</tr>
<tr>
<td>Separator</td>
<td>A separator to put between each of the components. Hyphens (-) and underscores (_) are commonly used. Using alphanumeric characters can create a confusing name format.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the name format.</td>
</tr>
</tbody>
</table>

Use the related list to add name components. Use the Order field to set the sequence in which name components are used.

The following name formats are defined in the base system.

<table>
<thead>
<tr>
<th>Name</th>
<th>Separator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>_</td>
<td>The default format. Document name and revision separated by an underscore.</td>
</tr>
<tr>
<td>Default Policy</td>
<td>_</td>
<td>The format for the policy document type.</td>
</tr>
<tr>
<td>Development documentation</td>
<td>(no separator)</td>
<td>The format for the software documentation type.</td>
</tr>
<tr>
<td>Development Sources</td>
<td>(no separator)</td>
<td>The format for the development and code sources type.</td>
</tr>
<tr>
<td>Intranet Improvement</td>
<td>(no separator)</td>
<td>The format for documents that describe intranet use.</td>
</tr>
</tbody>
</table>

**Defining Document Workflow**

In the base system, all managed documents use the Managed Documents workflow after the Active check box is selected.
Document workflow
The document parameters defined in the workflow are often used as conditions to trigger more specific workflows, such as type-specific workflows or classification-specific workflows. If different kinds of documents should follow different workflows, use the Graphical Workflow Editor to create new workflows.

**Knowledge document**

The Knowledge Document plugin extends the Managed Documents plugin by providing the functionality for managed documents to be published to the knowledge base.

**Installed with knowledge document**

These elements are installed with the knowledge document plugin.

**Dependencies**

The Knowledge Document plugin depends on the Managed Documents plugin. Activating Knowledge Document activates Managed Documents.

**Tables**

<table>
<thead>
<tr>
<th>Display Name [table_name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Records [m2m_document_knowledge]</td>
<td>A many-to-many table storing the relationship between a document and a knowledge article.</td>
</tr>
</tbody>
</table>

**UI Actions**

<table>
<thead>
<tr>
<th>UI action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to Knowledge</td>
<td>Creates or updates a knowledge article related to the current document, depending on whether a knowledge article already exists.</td>
</tr>
</tbody>
</table>

**Scripts**

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>KnowledgeDocument</td>
<td>Holds the main logic for the Knowledge Document plugin.</td>
</tr>
<tr>
<td>KnowledgeDocumentDB</td>
<td>Class that gets, inserts, and updates data for the Knowledge Document plugin.</td>
</tr>
</tbody>
</table>
Link documents to knowledge articles

Manage a document and access the latest version of the document from an article by linking the document to a knowledge article.

Your administrator must have activated the following plugins:

- Knowledge document plugin (com.snc.knowledge_document)
- Knowledge Management Advanced plugin (com.snc.knowledge_advanced)

The document is already uploaded and published. For more information, see Upload a document and Publish an approved revision.

You must have contribute access to the knowledge base within which the article linked to the document is stored.

If a knowledge article is already linked to the document, you must have contribute access to the article.

Role required: document_management_user and knowledge

You can link the initial or revised version of a document to a knowledge article. The document appears as an attachment to the linked article. Revising a document doesn't automatically update the document attached to the linked knowledge article. Therefore, every time you revise a document, you must again link the revised document to the knowledge article.

Note: As the owner of a document or an administrator, you can link the document to a published article. If the article is checked out by another user, you can't link the document to the associated article, unless the article is published.

1. Navigate to Managed Documents > Documents > All.
2. Click the document.
3. In the Knowledge Settings related list, fill in the fields.

Knowledge settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Behavior</td>
<td>Process performed when the Link to Knowledge related link is clicked.</td>
</tr>
<tr>
<td></td>
<td>A behavior is one of the following types:</td>
</tr>
<tr>
<td></td>
<td>• Always create record: A new knowledge article is created and linked with</td>
</tr>
<tr>
<td></td>
<td>the latest published revision of the document as an attachment.</td>
</tr>
<tr>
<td></td>
<td>• Update existing record: The linked knowledge article is updated with the</td>
</tr>
<tr>
<td></td>
<td>latest published revision of the document as an attachment. If no knowledge</td>
</tr>
<tr>
<td></td>
<td>articles exist for the document, a new knowledge article is created.</td>
</tr>
</tbody>
</table>

Note: Once you select a behavior setting for a document, you can't modify it later when revising the document.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge base</td>
<td>Knowledge base in which the knowledge article is stored. You can associate a knowledge article with one knowledge base only. If you are using an article template, you can modify this value only if the template is available in the other knowledge base.</td>
</tr>
<tr>
<td>Type</td>
<td>Article template to create a knowledge article using defined fields and values. <strong>Note:</strong> when a knowledge article is created, the Type field becomes read-only.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date that the article expires. Adds valid to date information to the same field in the knowledge article.</td>
</tr>
<tr>
<td>Short description</td>
<td>A few words or short phrase describing the knowledge article. Adds the short description to the same field in the knowledge article.</td>
</tr>
</tbody>
</table>

4. Click the Link to Knowledge related link.
5. Optional: In the information message that is displayed, click the message link to view the knowledge article.

The uploaded document is added as an attachment to a knowledge article. Depending on the Behavior field value specified in the Knowledge settings related list, the knowledge article is created or updated with the document.

**Create a document**

After Managed Documents parameters have been set by the administrator, documents can be created, requested, checked out, edited, checked in, copied, and, if necessary, rolled back to an earlier version.

Once documents have been added to the Managed Documents application, they can be grouped into document collections.

**Approval process**

During the approval process, the approver approves or rejects the document. A document goes through the approval process after the review process.

**Approval workflow**

After the document has been reviewed, submit the document for approval. If the document does not have an approver, the approval process is omitted.

When the document is **Active**, the workflow **Document Management Default** is used to manage approvals:
Document Management Default workflow
If the approver rejects the document, the author and owner are notified and the document review is cancelled. The author, owner, and approver should discuss what changes need to be made to the document. When the document is ready, a new review can be initiated.

If the final approver approves the document, the author and the owner are notified. Once final approval is successful, the document stage changes to **Ready for Publishing** in the Document Revisions list:

![Document Revision](https://example.com/diagram.png)

### Related Links

- [Show Workflow](#)

![Revision approvals](https://example.com/diagram.png)

### Process modification for multiple approvers

If there are multiple approvers, the approval process works in sequence and multiple approvers can be assigned to a single sequence. For example:

- **Sequence 1**: approvers A and B
- **Sequence 2**: approvers C and D
- **Sequence 3**: approver E

Because the sequences take place in ascending chronological order, approvers A and B receive the approval request first (approvers C, D, and E are not part of the process yet). Similar to the review process, the first approver to act within a sequence dictates what happens to the document. If approver A acts first and rejects the document, the approval process stops and the state is set to Cancelled. Approver B's status is changed to No Longer Required. If approver A acts first and approves the document, the process stops and approver B's status is changed to No Longer Required. Then, the document moves to approval.
sequence 2. After at least one approver in each sequence approves the document, the author and the owner are notified that the document has been approved.

**Review process**

During the review process, the reviewer approves or rejects the document. Sometimes a document will have multiple reviewers.

If the reviewer rejects the document, the author and owner are notified and the review is cancelled. The author, owner, and reviewer should discuss what changes need to be made to the document. If the reviewer approves the document, the author and owner are notified that the review was successful and the document can move to the approval stage.

If multiple reviewers are assigned to a document, the first reviewer to act dictates what happens to the document. For example, there are two reviewers, A and B. If reviewer A acts first and rejects the document, the review process stops and the revision state is set to Cancelled. Reviewer B receives a notification email stating that the review was rejected and their status is changed to No Longer Required. If reviewer A acts first and approves the document, the review process stops and the document can move to the approval stage. Reviewer B's status is changed to No Longer Required.

**Enable electronic signature for approval**

This topic explains how to enabling electronic signatures for approval. Electronic signatures are helpful if you must obtain a digital signature for compliance or auditing purposes.

You can activate the Approval with E-Signature plugin to require that users type in a user name and password when reviewing and approving documents.

The digital signature is not tracked or stored in the document record. Users must simply type in a user name and password after clicking the **Approve** or **Reject** button.

![Approver Authentication](image)

**Digital signature**

After activating the Approval with E-Signature plugin, ensure that a row in the e-signature registry table is created for the **dms_document_revision** table.

1. Navigate to **System Definition > e-Signature Registry**.
2. Check if **dms_document_revision** is already listed and **Enabled** is set to **true**.
3. If not listed, click **New**.
4. In **Table name**, select **Document Revision**.
5. Select **Enabled**.

6. Click **Submit**.

Publish an approved revision

This topic explains how to publish a document revision that has been approved.

Once a document has been created and edited, a specific revision can be submitted for draft review and final approval. After final approval, the document can be published.

Publish the approved revision from the Document Revisions list.

**Note:** Publishing documents to the Knowledge Base requires the Knowledge Document Plugin.

1. Navigate to the document record.
2. In the Document Revisions List, click the revision marked **Ready for Publishing**.
3. Click **Publish Revision** to display the **Publish** dialog box.

The revision number matches the latest revision number. If your standard is to change the revision number when the document is published, such as incrementing the version number to 1.1 or 1.0.1, the change can be made on this dialog box manually.
4. **Click Publish.**

   The published revision is highlighted in green and the stage of previous revisions is automatically changed to **Retired**:

   ![Revision Table]

   **Note:** If the approval and publishing process is repeated, the published revision is retired when the new revision is published. Any workflows running against previous revisions are canceled when the document is published.

---

**Submit a revision for draft review**

This topic explains how to submit a document draft for review.

Once a document has been created and edited, a specific revision can be submitted for draft review and final approval. After final approval, the document can be published.

When a draft of the document is ready, submit the draft for review. If the document does not have reviewers identified in the Reviewers field of the document record, the review process is omitted.

1. Navigate to the document record.
2. Right-click the appropriate revision.
3. Select **Submit Revision**. The revision stage is set to **Awaiting Review**.

![Document Revisions Table]

The document name and parameters are changed to read-only. The document state is set to **Active**.

![Document State Active]

**Create or request a new document**

Once an administrator has set parameters for the Managed Documents application, you can create or request new documents.

1. Navigate to **Managed Documents > Create New**.
2. Complete the following fields:

**New document fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>An identifying number for the document. Automatically generated using number maintenance.</td>
</tr>
<tr>
<td>Name</td>
<td>A name for the document. Note that the name for the document is combined with other naming components (as defined by the name format) to create the names for each document revision.</td>
</tr>
<tr>
<td>Requested by</td>
<td>The person asking that the document be created or updated.</td>
</tr>
<tr>
<td>Owner</td>
<td>The approver of the document request. Also responsible for setting completion date with requesters and authors.</td>
</tr>
<tr>
<td>Reviewers</td>
<td>The user or users who review the document and provide feedback to owners and authors.</td>
</tr>
<tr>
<td>Department</td>
<td>The department responsible for the document.</td>
</tr>
<tr>
<td>Type</td>
<td>The document purpose. This is a choice list derived from the type parameters.</td>
</tr>
<tr>
<td>Classification</td>
<td>The document classification, based on security, audience, and confidentiality. This is a choice list derived from the classification parameters.</td>
</tr>
<tr>
<td>Audience</td>
<td>The document readers, such as external or internal. This is a choice list derived from the audience parameters.</td>
</tr>
<tr>
<td>State</td>
<td>The current status of the document in the editing and publication process.</td>
</tr>
<tr>
<td>Checked out by</td>
<td>The user who currently has the document checked out.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description of the document.</td>
</tr>
<tr>
<td>Revision Settings</td>
<td></td>
</tr>
<tr>
<td>Name format</td>
<td>The format for the name of each individual revision of the document. For more information, see Defining Name Formats.</td>
</tr>
<tr>
<td>Revision format</td>
<td>A choice between the two digit (0.x) or the three digit (0.0.x) revision format.</td>
</tr>
</tbody>
</table>
The **User Permissions** related list determines which users have rights to view and contribute to the document:

**User permissions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>A reference to a user who is entitled to read and contribute to the document.</td>
</tr>
<tr>
<td>Type</td>
<td>A choice list describing how the user can interact with the document. Options are:</td>
</tr>
<tr>
<td></td>
<td>• Reader - The user can read the document versions.</td>
</tr>
<tr>
<td></td>
<td>• Editor - The user can upload new versions.</td>
</tr>
<tr>
<td></td>
<td>• Owner - The user can edit the document.</td>
</tr>
</tbody>
</table>

The **Group Permissions** related list determines which groups have rights to view and contribute to the document:

**Group permissions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>A reference to a group of users who are entitled to read and contribute to the document.</td>
</tr>
<tr>
<td>Type</td>
<td>A choice list describing how group members can interact with the document. Options are:</td>
</tr>
<tr>
<td></td>
<td>• Reader - Group members can read the document versions.</td>
</tr>
<tr>
<td></td>
<td>• Editor - Group members can upload new versions.</td>
</tr>
<tr>
<td></td>
<td>• Owner - Group members can edit the document.</td>
</tr>
</tbody>
</table>

**Specify an approver**

You can specify approvers for a document record after you save it.

You can have one approver or multiple approvers. For example, set multiple approvers to have one person do a quality check of the document and a different individual to serve as a final approver. Approvers are assigned a number. The lowest number (usually number one) approver always goes first, then any other approvers in ascending chronological order. Multiple approvers can have the same sequence number. For example, two approvers can do a quality check and be assigned sequence number 1. Then, two individuals can be final approvers and be assigned sequence number 2.

1. Navigate to the document record.
2. Right-click in the document header bar and select **Add Approver**.
3. Add a user name.
4. Select a sequence number from the drop-down list. (Lower numbers approve before higher numbers. For example, approver number one approves before number two.)
5. Click Add User.
6. Repeat steps 2-5 to add more approvers.

Check in a document

Check in the document after you revise it so other users can check out the document.

1. Navigate to the document record.
2. Select the Upload/Check In Revision related link.
3. Click Browse and navigate to the revised file.
4. Click Open.
5. Check the Name and Revision Number.
6. Click OK.

The Document Revisions related list updates to contain the most recent revision:

![Document Revisions screenshot]

Document revisions

Copy a document

A document can be duplicated at any time. This is useful if you have an existing document that you want to use as a base for a new document.

1. Navigate to the document record.
2. Right-click the header bar and select Copy Document.
   An information message with a link to the new document displays:
3. Click OK.
   The new document is renamed and includes the word "Copy."

Note: Only the latest revision is copied.
Deactivate a document

To change the document state to **Inactive**, deactivate the document. This is useful when changes to a document have been put on hold. An inactive document can be reopened at any time.

1. Navigate to the document record.
2. Right-click the header bar and select **Deactivate Document**.

   **Note:** To activate a document, right-click on the header and click **Reopen Document**.

Reopen a deactivated document

A document that has been deactivated can be reopened.

1. Navigate to the document record.
2. Right-click the header bar and select **Reopen Document**.

Roll back a document

A document can be rolled back to an earlier revision at any time. Before rolling back to an earlier revision, ensure that the document is not checked out and that you have Editor or Owner permissions for the document.

1. Navigate to the document record.
2. In the Document Revisions list, click the revision to which you want to roll back.
3. Right-click the header bar and select **Rollback**. The Rollback to Revision dialog box displays. The name and revision number are new. The note specifies the revision to which you are rolling back.

4. Change any information on the Rollback to Revision dialog box as necessary.
5. Click **OK**. The latest revision is now the revision you selected for rollback.
Cancel a document

Change the document state to **Cancelled** when no more changes will be made to the document.

When canceling a document, there is no confirmation message, so ensure that you want to cancel the document.

1. Navigate to the document record.
2. Right-click the header bar and select **Cancel Document**.

   An info message confirms the cancellation:
   
   The **State** is set to **Cancelled**:

   ![Cancelled State](image)

    MDQC cancel 3

Check out a document

Documents in the Managed Documents application can only be revised by one user at a time. Check out the document to revise it.

1. Navigate to the document record.
2. Select the **Check Out Document** related link.
3. Select **Download file** to download the current version of the document when it is checked out.

   ![Download file](image)

   Check out latest revision of document: Intranet Security
   
   Name: Intranet Security_0.0.4
   Revision: 0.0.4
   Created by: charles.beckley, 2018-09-14 06:30:10
   Last modified by: charles.beckley, 2018-09-14 06:30:44
   Document type: Procedure
   Download file

4. Click **Check Out**.

   After checking out a document, you can edit the document and make any necessary changes.
Create a document collection

A document collection is a set of individual documents. After documents have been uploaded into Managed Documents, organize the documents by grouping them into collections.

1. Navigate to Managed Documents > Document > My Collections.
2. Select New.
3. Type in a Name.
4. (Optional) Type in a Description.
5. Click Submit.
6. Click the name of the collection you created.
7. Click Edit.
8. On the left, double-click an available document or select a document and click Add.
9. Click Save. The Document Collection page displays and the individual documents in the collection are listed:

![Document Collection](image)

Click Update or Delete to modify the collection.

![Documents](image)

Click Collections to view the documents in the collection.
Upload a document

Upload a document into a saved record. You can upload text files, spreadsheets, presentations, PDF files, and more.

1. Navigate to the document record.
2. Click the **Upload/Check In Revision** related link.
3. Click **Choose File** and navigate to the file.
4. Click **Open**.
5. Check the Name and Revision Number.
6. Click **OK**.

After the initial document is uploaded, subsequent revisions can be created by checking out the document.

Domain separation and Managed Documents

This is an overview of domain separation in Managed Documents. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Support: Data only

Domain separation in this application is supported at the **Data only** level, meaning it supports the data security model of separating visibility of data from one domain to another. To learn more, see [Application support for domain separation](#).

MetricBase

The MetricBase application stores time-series data, which is data that is sampled at regular intervals. You can graph the stored data or use it with triggers to execute Flow Designer flows. MetricBase helps developers working with IoT-based applications that monitor or act on large amounts of machine-generated data.

How MetricBase works

You use MetricBase to deal with large amounts of data by using a smaller summary of that data that is stored in the MetricBase database. For example, an instance might store CPU usage. With MetricBase, you might summarize that data by storing the average CPU usage for every five-minute interval. You can graph the data or you can use it with Flow Designer to trigger flows.

MetricBase works with:

- An instance that stores machine-generated data
- A server that has the MetricBase application and database

On a very high level, when using MetricBase, you can:

1. Define the sampling rate for the data (float) on an instance. For example, you can sample the machine-generated data that is stored on an instance once every five minutes. This sampling rate is called the time-series definition.
2. Use a MetricBase API to send data from the instance to the MetricBase database at the rate that is prescribed by the time-series definition. If you send the data to MetricBase at a different rate, you get an error.

3. Use the Reporting application to graph the time-series data that is stored in MetricBase, or create triggers that execute Flow Designer flows. The time-series data remains in the MetricBase database for a prescribed amount of time, after which MetricBase deletes the data.

This figure shows that machine-generated data is sampled every 4 seconds. You send the average of the values in each sampling period to the MetricBase database, which stores the data until its expiration date.

**Benefits**

- MetricBase integrates seamlessly with ServiceNow IoT-based applications that monitor or act on large amounts of machine-generated data.
- MetricBase collects, retains, analyzes, graphs, and acts on time-series data.
- MetricBase works with Flow Designer to trigger flows and with Reporting to generate reports.

**Use cases**

- Create graphs about metrics, such as about CPU usage over time.
- Generate an email if the average CPU usage is more than 85% in the last 5 minutes.
- Train a machine language model to detect anomalies and execute a Flow Designer trigger when an anomaly is detected.
- If MetricBase detects a gap in data submitted for 10 minutes or more, generate an email.
- If the average of the collected data is less than 10 or greater than 500 in the last 5 minutes, generate an alert.
- If memory usage is likely to exceed 90% in the next 10 minutes, generate an alert.
**MetricBase demo**

Use the MetricBase Demo plugin to familiarize yourself with MetricBase. The demo contains sample metrics, triggers, and a scheduled job that collects and stores data. Use the demo to explore MetricBase before you set it up. The Data Explorer, which comes with the demo plugin, provides a place to experiment with MetricBase JavaScript APIs. The demo plugin is separate from the MetricBase plugin. Make sure to request both.

**Next**

Request the installation of the MetricBase and MetricBase Demo plugins.

**Purchase the MetricBase product**

The MetricBase application requires a separate subscription and must be activated by ServiceNow personnel. Be sure to request the MetricBase Demo plugin, which includes sample tables, metrics, triggers, and data.

Role required: none

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and sub-production instances, generally within a few days.

When ServiceNow personnel install the MetricBase Demo plugin, they also connect your instance to the server that contains the MetricBase database. A MetricBase database can connect with only one other instance. For example, a clone of the original instance can’t talk to the same database as the original instance.

- Play with MetricBase to get familiar with it.
- Define and collect MetricBase data.

**Getting familiar with MetricBase**

After ServiceNow personnel install the MetricBase and MetricBase Demo plugins, you can use the demo to get familiar with MetricBase.

**Prerequisites**

- MetricBase and the MetricBase demo plugins must be installed by ServiceNow personnel.
- Role required: admin

**MetricBase Demo**

With the MetricBase Demo plugin, you can experiment with MetricBase without configuring it or knowing much about it. The plugin includes sample time-series data and triggers in your MetricBase database to help you visualize the data and see how triggers operate. The demo also includes scheduled time-series data updates, as if they had been received from an instance, so you can test the functionality of the included triggers.

In the demo, a fictional fleet of drones has been outfitted with sensors that broadcast their metrics, including their speed, altitude, and battery life over time.
1. Navigate to **MetricBase Demo > Drones**
   to see the name, model, length, width, altitude, and speed for all drones in the fleet.

   ![Table of drones](image1)

2. Click **MetricBase Demo > Metrics** to see how the metrics are defined.
   In the Time Series Metrics list, the column values specify the table where the drone's time-series metrics are stored, the names of all the metrics that are stored for each drone, and the retention policy for each metric. The retention policy specifies how frequently measurements are taken, and how long MetricBase retains that data.

   ![Metrics list](image2)

   Now that you've seen the drone data and learned how to find it, let's see how the data was collected using a retention policy.
3. Click a retention policy.
   The Retention Policy form shows the definition for the policy. In the following example, this metric is measured once a minute for the first 8 days, then once every 10 minutes for the following 94 days, and then once an hour for the following 397 days. After that, the system discards the data.

   ![Retention Policy Schedules](image)

   For more information on retention policies, see Define and collect time-series data.

4. To see how the data is aggregated during the Retention Durations, click the left arrow (<) at the top of the Retention Policy Schedules window to return to the Time Series Metrics list.

5. Click a table name.
   The Time Series Metric definition shows the **Retention policy aggregator**. This aggregator summarizes the data as, for example, the average, maximum, or minimum value in the aggregation period. In the following example, the admin clicked the table for the speed metric. The result is that MetricBase stores the speed averages during each sampling period in the MetricBase database.

   ![Time Series Metric - Speed (kph)](image)

   ![Retention policy aggregator](image)

   Now that you understand how the data was collected using retention policies, let's see how to display the data in lists and graphs.
6. Notice the parameter fields that start with **Display**. In this example, they mean that the speed values that are displayed in the list view of drones are the last speeds recorded in every hour interval for each drone.

These **Display** fields control what appears in the list view of the drones only. They have nothing to do with the retention policy.

7. Display the list view of a table by entering `<table-name>.list` in the **Field navigator** field. For example, `mb_demo_drone.list`.

All drone data appears. In the example from the previous step, the speed column would contain the **Last** value of the sampling period.

8. Click **MetricBase Demo > Drones** and look at the speed (kph) column.

From the previous step, you know that these values are the last speeds recorded for each drone up to an hour ago. The values are the same as you would get by using the `.list` command.

9. Click the speed value of the first drone.

The following graph shows the speed of the drone that was measured hourly.

![Graph showing drone speed](image)

**Note:** You might need to select a different **Time Span** field value to get a clearer graph. For example, try **1 Day**. The speed is a sine wave because it's artificially generated. Hover over the sine wave to see the actual measurements.

10. Click the left arrow (<) to return to the list of drone metrics, right click on one drone type (**Model** column), and select **Show Matching**.

Only the drones of the selected type appear.

11. Click the menu icon (☰) next to the Altitude column heading and select **Time Series Chart**.

You see a graph that shows the altitude measurements of the Warbler-T7-type drones.

![Graph showing drone altitude](image)

You might like to change the **Time Span** value for a clearer graph.
12. In the Transform field, select Envelope. You see a graph that shows the minimum and maximum (envelope) altitudes for the fleet of Warbler T7 drones over time.

13. Click the left arrow (←) to return to the list of drone metrics.

14. Click the menu icon (⋮) next to the Altitude column heading and select Time Series Chart Designer to see another way of visualizing the data.
15. In the Create a Report page that displays in the Reporting application, vary with the graph parameters.

**Note:** In the following steps, to stay on the same page, click Run. To advance to the next page when designing the graph, click Next.

a. Change the **Last** value to one day and click **Next**.

b. In the Style pane, change the **Chart color** value and click **Run**.

c. Click **Type**, select the kind of graph to display, and click **Run**.
d. Click **Configure**, select a transform to run on the data from the **Transform** list, and click **Run**.

e. Edit the report title, which is above the graph, and click **Run**.

f. Click **Configure**. In **Time range**, select the time line to display on the graph.

**Note:** **Relative** uses the **Last** timespan relative to the present time. For example, if **Last** is 1 hour, the time line in the graph always spans the previous hour. You can add this report to your dashboard to show the metrics in the previous hour.
You've displayed drone data in lists and graphs. Now, let's define a trigger that executes when data that you monitor reaches a threshold value.

16. Click MetricBase Demo > Trigger Definitions.

The MetricBase Trigger Definitions list shows the name (Name) of the trigger, the metric (Metric) the trigger monitors, the table (Table name) the metric that it is in, the trigger description, and whether the trigger is active. Triggers kick off flows when metrics meet trigger thresholds. An example is when a drone flies too low. For more information about triggers, see Trigger Workflows.
17. Click **Low-Battery Drone**.

The MetricBase Linear Predictor trigger form displays the definition of the Low-Battery Drone trigger.

In this example, the trigger monitors the **Remaining Battery (%)** metric (**Metric**) in the Drone table (**Table name**) every 10 minutes (**Window**). If the battery life is trending downward (**Trend**) and is 80% likely (**Confidence Level**) to reach 20% (**Threshold**) within 20 minutes (under **Window** for **Level** 1), the trigger executes. Although it fires, nothing happens until you associate this trigger with a flow. The flow defines the actions to take.
18. Click **MetricBase > Triggers**. Flow Designer opens.

19. Click **New > New flow** to associate a trigger that is defined in the system to a flow.
20. In the **Name** field, name the flow and click **Submit**.

21. Click **Click to add a Trigger** and select **MetricBase** in the list.

22. In **MetricBase Trigger**, select a trigger that already exists and click **Done**.
   Alternately, you could click the plus sign to the right of **MetricBase Trigger** to create a new trigger.

23. Click **Click to add an Action, Flow Logic, or Subflow**.
24. Click **Action** to specify the actions to take when the trigger fires. The Action modal appears.

![](image)

25. Select a domain of actions from the left column and the specific action to take in the right column.

26. Click **Save** and **Activate**.

The flow doesn't execute unless it is activated. For more information about Flow Designer, see Flow Designer.

The following table summarizes the modules in the MetricBase demo.

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drones</td>
<td>Table that keeps metrics on drones, such as speed and altitude. Each record is a different drone. You can add records.</td>
</tr>
<tr>
<td>Fleets</td>
<td>Table that maintains metrics about groups of drones. Each record is a different fleet. You can add records.</td>
</tr>
<tr>
<td>Data Generators</td>
<td>Table that defines how data is created for the drone records. This field is provided for informational purposes. You cannot change or add records.</td>
</tr>
<tr>
<td>Metrics</td>
<td>List of metrics that are defined in the system. This list is the same table as MetricBase &gt; Time Series Metrics. You can add metric fields.</td>
</tr>
<tr>
<td>Scheduled Jobs</td>
<td>Scheduled job that is created for the demonstration application. The job runs every five minutes to add data to the demo tables in the MetricBase database. You can change the schedule.</td>
</tr>
</tbody>
</table>
### Trigger Definitions

List of triggers that are defined in the demo. This list is the same table as MetricBase > MetricBase Triggers > Trigger Definitions. You can create additional triggers.

### Anomaly Logs

List of logs that result from triggers firing. The Low-Flying Drone trigger creates the anomaly logs.

### Data Explorer

Widget that enables you to experiment with MetricBase JavaScript APIs using the demonstration application data. See Get Familiar with MetricBase APIs for more information.

---

### Next topics

- Set up MetricBase.
- Explore the MetricBase JavaScripts APIs.

### Define and collect MetricBase data

MetricBase stores time-series summaries of much larger data collections. In MetricBase, you specify the metric that you want to store, how often to collect it, and how long to store it in the MetricBase database. Then, you send the data from an instance to the MetricBase server at the rate that you define using MetricBase REST or JavaScript APIs. In this way, you can monitor a much large data collection with MetricBase summaries of it.

- Install MetricBase
- Role required: clotho_admin

You use MetricBase to work with large amounts of machine-generated data by storing a smaller summary of that data in MetricBase.

You use MetricBase to define how often you will send data to MetricBase and what the aggregation of that data is, for example, maximum, minimum, average, or last. This data is called time-series data. For example, if you collect drone speeds on an instance, you might send the average the drone speed for every two minutes to the MetricBase database. This data might be one of many time-series metrics that you collect. You might also collect altitude and battery life. MetricBase stores each metric as a column in its database.
Retention schedules specify how long MetricBase stores the time-series data in the MetricBase database. The syntax is `<retention duration> @ <time-series-definition>`. For example, 30 Days @ 5 Minutes, means that the specified metric is sampled every 5 minutes and that data remains in the MetricBase database for 30 days.

Retention policies include multiple retention schedules with coarser granularity the longer that the data is kept. For example, the Coarse retention policy stores sampled data every:

- Hour for one week (7 Days @ 1 Hour interval)
- Two hours for one month (31 Days @ 2 Hour interval)
- Day for 13 months (397 Days @ 1 Day interval)

In this policy, the specified metric is measured every hour for the first 7 days, every other hour for the next 31 days, and once a day for next 397 days. MetricBase deletes data that is older than 435 days.

To see the list of all supported retention policies, navigate to MetricBase > Retention Policies.

1. Navigate to MetricBase > Time Series Metrics and click New to create a time-series definition.
2. On the form, fill in the fields.

Time series metric form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Intuitive name for the <strong>Metric field name</strong>. For example, altitude could be the label for the metric field name, mb-altitude.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Table name | Name of the table to add the metric to in the MetricBase database. For example, in the MetricBase Demo, the mb_drone table stores all of the drone data. Each column in the table is a different metric, for example, altitude, length, and speed.
Metric field name | Name of the time-series metric being recorded. For example, mb-altitude. You can think of it as the name of a column in the MetricBase database table.
Retention policy | Sampling frequency and how long MetricBase keeps the values in the database. You cannot customize the value. For a definition of the values, click the magnifying glass and then a policy. The coarser the sampling rate, the less data is stored. Use the coarsest sampling rate that works for your dataset. For example, do not collect data every minute if collecting it once an hour suffices.
Retention policy aggregator | Operator that is used to aggregate all of the data in a sampling period. For example, last, minimum, maximum, and average.
Display value aggregator | Aggregation method that is used only when using `<table-name>.list` where `<table-name>` is a table in the MetricBase database. This value is unrelated to the retention policy. For a definition of the options, see MetricBase transforms.
Display value aggregate duration | Duration that is used to calculate the aggregation only when using the list view. For example, `<table-name>.list` where `<table-name>` is a table in the MetricBase database. This value is unrelated to the retention policy.

You've created a time-series specification for a metric that you want to track.

3. Click **Submit**.
4. Sample the data according to the time-series specification and send it from an instance to the MetricBase database server.

There are many ways to send the data to the MetricBase database. The following example shows how to use REST and JavaScript APIs. For information about the MetricBase REST APIs, see the Clotho Time Series API. For information on the MetricBase JavaScript APIs, see Client, Data, DataBuilder, Transformer, TransformPart, TransformResult.

**Note:** You must send the data at the rate that is prescribed by the time-series definition. If you send the data at a different rate or for a different duration, you receive an error. Make sure to aggregate the data according to the time-series metric definition. Also, the MetricBase database only stores values of data type float.

You can gain experience with the APIs by using the Data Explorer. For more information, see Get familiar with MetricBase APIs.

#### Store time-series data using REST and JavaScript APIs

The following examples store time-series data in the MetricBase database using REST and JavaScript APIs. The following example uses REST.

```
curl -X POST -H "Content-Type: application/json" -H "Accepts: application/json"
```
• `sys_id-of-data-source`—Sys ID of the object that generates the metric. For example, in the MetricBase Demo, this would be the `sys_id` of a drone.
• `metricbase-table`—Name of the table in the MB database that stores the time-series data.
• `metric-name`—Metric field name of the metric that is recorded in the database.
• `start-time-of-data`—Time that the data was sampled from the instance, for example, 2019-04-02T03:00:00Z.

**Note:** Line returns were introduced into the curl statement to make it fit on the page. To use the code, remove the line returns.

If you prefer to use a JavaScript API to store the time-series data in the MetricBase database, here’s a similar example:

```javascript
var count = 60 * 48; // 2 days of data
var values = [];
for (var i = 0; i < count; i++) {
    values.push(Math.random());
}

var now_GR = new GlideRecord('<metricbase-table>');
gr.get('<sys_id-of-data-source>');</gr.start = new GlideDateTime();
start.addSeconds(-1 * 60 * count);
var dataBuilder = new sn_clotho.DataBuilder(gr, '<metric-name>').add(start, values);
new sn_clotho.Client().put(dataBuilder);
```

• `sys_id-of-data-source`—Sys ID of the object generating the metric. For example, in the MetricBase Demo, this would be the `sys_id` of a drone.
• `metricbase-table`—Name of the table in the MB database that stores the time-series data.
• `metric-name`—Metric field name of the metric that is recorded in the database.

• If you use a predictive model to detect anomalies, create a predictive model. To see how, refer to Detect anomalies using predictive models.
• View the metrics that are stored in the MetricBase database. To see how, refer to View the metrics.
• Set up triggers that execute Flow Designer flows. To see how, refer to Set up triggers.

**Detect anomalies using predictive models**

Submit MetricBase data to train a model, which you can use with a model trigger. Use models to detect data that varies from normal values.

Role required: admin

MetricBase supports the probabilistic exponentially weighted moving average (PEWMA) model. You need to run data through the model to train it. Training is the process of entering a lot of normal data into the
model so it can determine the model parameters that best fit the normal data. In this way, the model can distinguish anomalous data. When you choose the data to train your model, make sure to eliminate all anomalous data.

1. Navigate to MetricBase > MetricBase Models and click New.
2. On the form, fill in the fields.

Model New Record form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model name</td>
<td>Name of the model. The name can be any combination of alphanumeric characters. This model name is not the same as the PEWMA model type. In general, the name relates to the value in Group by.</td>
</tr>
<tr>
<td>Table name</td>
<td>Name of the table that contains the training data.</td>
</tr>
<tr>
<td>Metric</td>
<td>Name of the metric that you use to train the model. The metric must be in the table.</td>
</tr>
<tr>
<td>Created</td>
<td>Date that you trained the model.</td>
</tr>
<tr>
<td>Filter</td>
<td>Filters that you use to exclude some of the data in the dataset.</td>
</tr>
<tr>
<td>Group by</td>
<td>Field that is the basis of the predictive model. For example, if you select altitude, you generate a model based on the altitude metric, which establishes what is normal for altitude. To create multiple models, select a field, and click Submit and Train. To create a different model, select a different field in Group by, and click Submit and Train.</td>
</tr>
<tr>
<td>Training Dataset Start Date</td>
<td>First date in the dataset to start with. The data in the table starting with this date is used to train the model.</td>
</tr>
<tr>
<td>Training Dataset End Date</td>
<td>Last date in the dataset that you want to use. The data in the table from the start date up to this date is used to train the model.</td>
</tr>
<tr>
<td>Valid until</td>
<td>Date that serves as a reminder to consider retraining the model. If the model is performing well, there's no need to retrain it. The model can continue working past this date.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to use the trained model.</td>
</tr>
</tbody>
</table>

3. Click Submit and Train.
MetricBase trains the model. When complete, the model appears on the MetricBase Model Instances tab.
4. Click the model name. 
The modeling data appears as does the model string with the parameters optimized by the training.

5. Optional: Change the model parameters and click **Update**.
6. Optional: Change the model parameters and click **Update**.

The graph does not update. By clicking **Update**, you only save the revised model string.

The PEWMA parameters are:

- **Alpha**—A greater value means that more data is used to calculate the weighted average. Also, the weighted average line is smoother.
- **Beta**—A greater number means that the model is more sensitive to variations from the mean. The following images show differing beta values. The second image has a lower beta and a higher tolerance for variations from the predicted value.
7. Optional: Click **Delete** to delete the model.
8. Click the **MetricBase model triggers** tab to create a Flow Designer trigger for this model. For more information, see [Create a model trigger](#).

**Access MetricBase data**

Access the time-series data that you sent to the MetricBase database in the way that is convenient to you.

Role required: admin

You can access and visualize time-series data in the MetricBase database by using:

- **Reporting application**
  
  You can generate reports and graphs from the time-series data that is stored in the MetricBase database. For more information, see [Create reports from MetricBase time-series data](#).

- **Table lists using the .list command**
  
  For more information, see [View MetricBase data using the list command](#).

- **REST or JavaScript APIs**
  
  For more information, see [Retrieving MetricBase data using REST and JavaScript](#)

**Access MetricBase data using the list command**

Use the list command on a table in the MetricBase database to view time-series data. The data reveals the behavior of the entity that supplies the data.
Role required: admin

1. On the MetricBase instance, in the application navigator, type `<table-name>.list`, and press the Enter key. 
   `<table-name>` is the name of the table in the MetricBase database that contains the metric you want to view.

2. Click the menu icon above the metric column, and select **Time Series Chart**.

3. Change the **Time Span** and **Transform** fields to evaluate the data.

4. Optional: Adjust the data:
   a) Select one of the transforms: **Add**, **Multiply**, or **Divide**.
   b) In the **Value** field, enter the number to add, multiply, or divide the metric data by and click **Submit**.

   **Note:** The adjusted data is not saved in the MetricBase database.

**Retrieving MetricBase data using REST and JavaScript**

Use JavaScript or REST APIs to retrieve time-series data from the MetricBase database and to run transforms on the data. The transformations enable you to visualize time-series data in a variety of ways.

For more information about MetricBase time-series data transformations, see MetricBase transforms.

**Using REST**

For information about the MetricBase REST APIs that return time-series data from the MetricBase database, see:

- Clotho Time Series API, which inserts, retrieves, and transforms data in the MetricBase database.
- MetricBase Data Explorer that comes with the MetricBase Demo, and enables you to experiment with the APIs.

**Using JavaScript**

For information about the MetricBase JavaScript APIs that return time-series data from the MetricBase database, see:

- **Client** — Execute transforms on the MetricBase database and receive the results.
- **Data** — Return the object that contains the result of a transform.
- **DataBuilder** — Create a series of data points for a metric.
- **Transformer** — Manipulate time-series data to prepare the data for evaluation and analysis.
- **TransformPart** — Specify details of the transform to be done.
- **TransformResult** — Return the object that contains the result of the transformation.

**Analyze time series data with JavaScript APIs**

This example returns the average CPU usage over the specified time for each XYZ computer.

```
// Query the cmdb_ci_computer table for the records for
```
```javascript
var now_GR = new GlideRecord('cmdb_ci_computer');
gr.addEncodedQuery('manufacturer=xyz');
gr.query();

// Create a DataSelector object and specify the metric (cpu_percentage),
// the transform (avg), and label (avg cpu)
var transform = new
    sn_clotho.Transformer(gr).addMetric('cpu_percentage').avg()
    .label('avg-cpu-percentage');

// Run the transform between startTime and endTime.
// startTime and endTime are GlideDateTime
var data = transform.execute(startTime, endTime);
var values = data['avg-cpu-percentage'].getValues();
```

**Filter data**

Developers can use SQL WHERE clauses in transformation scripts to filter data in report visualizations. Transformations in clotho aggregations apply mathematical functions on metric records. Use SQL WHERE clauses in transformation scripts to filter data. In the following example, the WHERE clause filters out all results except those results where `mb_demo_mt_speed` equals 100.

```javascript
var eqCon = new sn_clotho.Condition().eq(100);
var builder = new sn_clotho.Transformer(drones);
var fit = builder.metric("mb_demo_mt_speed").where(eqCon);
```

**MetricBase triggers**

Time-series data that is stored in the MetricBase database can trigger Flow Designer flows. These triggers can log incidents, send emails, and create other alerts.

You use MetricBase to define a trigger on an instance. When you associate the trigger with a Flow Designer flow, the trigger definition transfers from your instance to the MetricBase server. When you make the trigger and flow active, the trigger monitors the time-series data that is stored in the MetricBase database. When data meets the triggering conditions, MetricBase adds the trigger alert to the Trigger queue. The instance regularly polls that queue. When the polling finds a trigger waiting in the queue, the Flow Designer flow executes on the instance.
For more information about time-series policies, see Define and collect MetricBase data.

High-level overview of implementing triggers

1. Define one or more of the following triggers on an instance:
   - Band trigger — Triggers when a metric value falls within a range of values.
   - Linear Predictor trigger — Triggers when a series of values trend toward and are expected to reach a specified value.
   - Gap trigger — Triggers when values are not received for a period of time.
   - Model trigger — Triggers when a trained model detects anomalous behavior.

2. Create a trigger condition to add additional requirements for a trigger to execute a flow.
   For example, data often fluctuates over time. Small fluctuations can cause unwanted, duplicate triggering events. A Condition Script can prevent that erroneous duplication.

3. Associate the trigger with the flow it executes using Flow Designer.

4. Test the trigger and workflow.

5. Activate the trigger.

Deleting triggers

You can't delete a trigger in MetricBase if it is associated with a flow in Flow Designer. To delete a trigger, you must first delete the flow in Flow Designer and then you can delete the trigger in MetricBase.
Legacy triggers

Legacy triggers are deprecated. You can't create new ones; you can only carry forward ones that already exist. To see them, navigate to Legacy triggers.

Create a MetricBase band trigger

Create a MetricBase band trigger that detects when a metric value falls within a range of values.

Role required: admin

Band triggers execute when metrics fall outside of or within a range of values.

1. Navigate to MetricBase > MetricBase Triggers > Trigger Definitions and click New.
2. On the MetricBase Trigger Creation form, click Band Trigger - Detects and takes action when metric value meet certain threshold or is within a range.
   On the MetricBase Band Trigger form, you can see the table and tracked metric but not the band trigger parameters.
3. On the form, fill in the fields.

MetricBase Band Trigger form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the band trigger.</td>
</tr>
</tbody>
</table>
### Table name

Table in the MetricBase database that contains the metric that you want to monitor. The only tables that appear when you click the search icon are the tables that you specified in the time-series metrics.

If you select a metric before you select a table, only tables that have that metric appear in the Table name modal.

### Metric

Table metric that you want to monitor that is specified by the **Table name**. The only metrics that appear when you click the search icon are the metrics in that table.

If you select a metric before you specify a **Table name**, the metrics in all your time-series metrics appear. After you select a metric, only the tables that contain that metric appear when you click the search icon that is next to the **Table name**.

### Active

Option to activate the trigger.

### Description

Description of the trigger.

### Aggregator

Aggregation value that you select: **None**, **Max**, **Min**, or **Average**. **None** means that you use the last value in the collection interval.

---

4. Click **Save**.
5. In the MetricBase Band Trigger Levels area, double-click each cell to add values that specify trigger parameters.

### MetricBase Band Trigger Levels

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Level</strong></td>
<td>Numbers that indicate increasing severity. For example, you might define the CPU usage for level 1 to be above 85% and the CPU usage for level 2 above 90%. Each level should trigger a different flow. <strong>Level</strong> is often used in Conditional Scripts.</td>
</tr>
<tr>
<td><strong>Function</strong></td>
<td>Function that makes the <strong>Value</strong> the maximum or minimum value of the lower end of the band and defines whether trigger values are inside or outside of the band. For example, if the <strong>Function</strong> is <strong>Less than</strong>, the trigger executes when the metric goes below band.</td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td>Lower end of the band. See the following image.</td>
</tr>
<tr>
<td><strong>Band Function</strong></td>
<td>Function that makes the <strong>Band Value</strong> the maximum or minimum value of the upper end of the band and defines whether trigger values are inside or outside of the band. For example, if the <strong>Band Function</strong> is <strong>Greater than</strong>, the trigger executes when the metric goes above the band. See the following image.</td>
</tr>
</tbody>
</table>
### Create a MetricBase linear predictor trigger

Create a MetricBase linear predictor trigger to detect when a metric is likely to cross a specified threshold within a specified period of time.

**Role required:** admin

The linear predictor trigger uses past data to generate a line that predicts future values. When MetricBase predicts that the linear value will reach a *threshold*, the trigger executes.
If the most recent data point reaches the threshold, the trigger executes regardless of the linear prediction.

Trigger parameters include how much past data to use in the calculation of the prediction, how far ahead to look, and the level of confidence that you accept.

1. Navigate to MetricBase > MetricBase Triggers > Trigger Definitions > New.
2. Click Linear Predictor Trigger - Predicts and takes action when a metric follows an upward or downward trend and is expected to reach a given threshold in the future.
3. On the form, fill in the fields.

**MetricBase Linear Predictor Trigger form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that you give the trigger.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table in the MetricBase database that contains the metric that you want to monitor. The only tables that appear when you click the search icon are the tables that you specified in the time-series metrics. If you select a metric before you select a table, only tables that have that metric appear in the Table name modal.</td>
</tr>
<tr>
<td>Metric</td>
<td>Table metric that you want to monitor that is specified by the Table name. The only metrics that appear when you click the search icon are the metrics in that table. If you select a metric before you specify a Table name, the metrics in all your time-series metrics appear. After you select a metric, only the tables that contain that metric appear when you click the search icon that is next to the Table name.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the trigger.</td>
</tr>
</tbody>
</table>
Field | Description
---|---
Window | Length of time that you want to use to calculate the line that predicts the future course of the value. For example, you might want to use the last 10 minutes of data to calculate the linear predictor. If the value is too long, the line does not reflect current trends. If the value is too short, the line might follow the raw values too closely and not accurately reflect the overall trend of the values. The value must be at least 10 times the sampling period that is defined by the sampling rate of your Metric. The format is hours:minutes:seconds. Do not confuse this value with the value of Window in the trigger level. That value specifies how far into the future that you want the linear predictor to look to see if the Metric is likely to cross the Threshold.
Confidence Level (%) | Percentage that specifies how tolerant you are of the real data fitting the linear prediction of the data. For example, a confidence level of 95% means that the real value must be within 5% of the predicted value in order to execute a trigger. If you only want to trigger when the real values are close to the predicted values, choose a high confidence percentage. If you are willing to accept real data that varies more significantly from the predicted values as being valid, select a lower confidence level, for example, 80%.
Trend | Direction of the trend: increasing or decreasing. For example, the value is increasing or decreasing toward the Threshold.
Threshold | Target value that the metric is expected to reach before the trigger executes.
Description | Description of the trigger.

4. Click **Save**.
   In the MetricBase Linear Predictor Trigger Levels form, you can create multiple trigger levels of increasing severity. For example, you can configure the battery level to be 80% for level one and at 90% for level two.

5. In the MetricBase Linear Predictor Trigger Levels area, double-click each cell to add values that specify trigger parameters.

**MetricBase Linear Predictor Trigger Levels**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>Numbers that indicate increasing severity. For example, you might define level 1 to be CPU use is predicted to reach 85%. Level 2 might be CPU use is predicted to reach 90%. Each level can trigger a different Flow Designer flow.</td>
</tr>
<tr>
<td>Function</td>
<td>Function to use on the value. For example, Less than or is.</td>
</tr>
<tr>
<td>Window</td>
<td>How far into the future that you want the linear predictor to look to see if the metric is predicted to cross the threshold. Do not confuse this value with the Window value in the trigger definition form. That value specifies how much data to use (measured in time) to calculate the slope of the predictor line.</td>
</tr>
</tbody>
</table>

6. Click **Update**.

7. Optional: Add a triggering condition that determines whether or not a trigger executes a Flow Designer flow.
   For more information, see **Create a triggering condition**.

   Associate this trigger with a Flow Designer flow. For more information, see **Assign a trigger to a flow**.
Create a MetricBase gap trigger

Create a MetricBase gap trigger to alert you when MetricBase stops receiving data.

Role required: admin

Gap triggers execute when MetricBase stops receiving data for a specified period.

You can define multiple trigger levels to indicate different severities. For example, you can set a gap of 15 minutes as level 1, a gap of 30 minutes as level 2, and so on. Each level should trigger a different Flow Designer flow. The difference between gap durations on different levels must be at least 10 minutes. For example, if you set level 1 to a gap of 15 minutes, you must set level 2 to a gap of 25 minutes or more.

Note: If you make the gap durations between levels less than 10 minutes, MetricBase displays an error message and deletes the level that you added.

MetricBase calculates how often to poll data by taking the difference between gap durations on different levels and dividing them by 2. For example, if level 1 triggers after 20 minutes of missing data and level 2 triggers after 40 minutes of missing data, the polling frequency is $\frac{40-20}{2} = 10$ minutes. The maximum polling frequency is every 5 minutes, and the minimum frequency is every 30 minutes. If a trigger has only one level, the polling frequency is 30 minutes.

MetricBase searches through the data that is stored in the MetricBase database, not through incoming data. For that reason, a gap trigger might execute after the gap when data is missing. For example, if MetricBase polls the database every 10 minutes and the gap is 30 minutes of missing data, the trigger might execute as late as 40 minutes after the data was last received.

1. Navigate to MetricBase > MetricBase Triggers > Trigger Definitions > New.
2. In the MetricBase Trigger Creation form, click Gap Trigger - Detects and takes action when no data is received for a metric.
3. On the form, fill in the fields.

MetricBase gap trigger form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the trigger.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table name</td>
<td>Table in the MetricBase database that contains the metric that you want to monitor. The only tables that appear when you click the search icon are the tables that you specified in the time-series metrics. If you select a metric before you select a table, only tables that have that metric appear in the <strong>Table name</strong> modal.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the trigger.</td>
</tr>
<tr>
<td>Metric</td>
<td>Value the trigger monitors in the MetricBase database.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the trigger.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

5. In the MetricBase Gap Trigger Levels area, double-click each cell to add values that specify trigger parameters.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>Numbers that indicate increasing severity. For example, you might define level 1 to be no data for 1 minute. Level 2 might be no data for 5 minutes. Each level should trigger a different flow.</td>
</tr>
<tr>
<td>Function</td>
<td>Function, <strong>Greater than or is</strong>, which means that this trigger executes when the gap in received data is greater than the value that you specify in the <strong>Window</strong> field.</td>
</tr>
<tr>
<td>Window</td>
<td>Length of time that no data has been received that executes the trigger. The format is hours:minutes:seconds. For example, 00:20:00 means that this trigger executes after 20 minutes of missing data.</td>
</tr>
</tbody>
</table>

6. Click **Update**.

7. Optional: Add a triggering condition that determines whether or not a trigger executes a Flow Designer flow.
   
   For more information, see [Create a triggering condition](#).

Associate this trigger with a Flow Designer flow. For more information, see [Assign a trigger to a flow](#).

### Create a MetricBase model trigger

Model triggers execute when the time-series data deviates from expected values.

Role required: admin

Probabilistic exponentially-weighted moving average (PEWMA) is the only model type supported. MetricBase uses this model to create a definition of expected, normal values.

1. Click **MetricBase > MetricBase Triggers > Trigger Definitions** and click **New**.
2. Click **Model Trigger** - Detects and takes action when a metric value deviates from the trained model.

The MetricBase Model Trigger form specifies the table and metric used to train the model.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name the model trigger.</td>
</tr>
<tr>
<td>Model</td>
<td>Trained model this trigger uses.</td>
</tr>
<tr>
<td>Metric</td>
<td>Automatically filled in based on the model.</td>
</tr>
<tr>
<td>Table name</td>
<td>Automatically filled in based on the model.</td>
</tr>
<tr>
<td>Description</td>
<td>Explanation of the trigger.</td>
</tr>
<tr>
<td>Spike Direction</td>
<td>Trigger execution criteria. Specify whether you want to trigger only on anomalies that occur above predicted values, only on anomalies that occur below predicted values, or both.</td>
</tr>
<tr>
<td>Window</td>
<td>Amount of data to use when calculating the moving, weighted average; the longer the window, the more data. The recommendation is 30 times the sampling interval. For example, if the time-series data is sampled every minute, make this value 30 minutes. Values must be multiples of the sampling interval.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Active</td>
<td>Turns on the trigger.</td>
</tr>
</tbody>
</table>

**Note:** For the **Window** value, very short durations make the weighted average move with the data itself and fail to detect anomalies. Very long durations make the weighted average unresponsive to current trends in the data and may cause false triggers.

4. Click **Save**.
5. In the MetricBase Model Trigger Levels area, double-click each cell to add values that specify trigger parameters.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>Numbers that indicate increasing severity. For example, you might define level 1 to be 3 standard deviations from the mean. Level 2 might be 5 standard deviations. Each level should trigger a different Flow Designer flow. <strong>Level</strong> is often used in Conditional Scripts.</td>
</tr>
<tr>
<td>Function</td>
<td><strong>Always Greater than or is</strong>, meaning that in order to trigger, the time-series metric must be greater than or equal to the number of standard deviations from the mean specified in <strong>Number of Standard Deviations</strong>.</td>
</tr>
<tr>
<td>Number of Standard Deviation</td>
<td>Float value specifying the number of standard deviations the time-series metric must be away from the mean to trigger an alert at this level.</td>
</tr>
</tbody>
</table>

6. Optional: Add additional rows in the table to create multi-layered triggering behavior. Each successive row should indicate a more severe condition.

7. Click **Update**.
   The MetricBase Trigger Definitions page displays the list of defined triggers.

8. Test your model and trigger on real data before deploying to production.
9. Optional: Add a triggering condition that determines whether or not a trigger executes a Flow Designer flow.

   For more information, see Create a triggering condition.

Associate this trigger with a Flow Designer flow. For more information, see Assign a trigger to a flow.

**Execute triggers conditionally**

MetricBase triggers execute based on a single metric. Condition Scripts impose additional requirements that determine whether a trigger kicks off a flow.

Role required: admin

Condition Scripts execute when conditions for a trigger are met but before the trigger executes a Flow Designer flow. In that way, Condition Scripts can prevent triggers from executing flows even when trigger conditions are met. For example, data often fluctuates over time. Small fluctuations can cause unwanted, duplicate triggering events. A Condition Script can prevent that erroneous duplication.

Condition Scripts always return True (trigger) or False (do not trigger). To learn how to write these scripts, see Scripting in ServiceNow Fundamentals. To experiment with scripts, see Get familiar with MetricBase APIs.
You can create and save Condition Scripts in MetricBase but you associate them with triggers using Flow Designer.

1. Click **MetricBase > MetricBase Triggers > Trigger Condition Script > New.**
2. On the Additional MetricBase Trigger Filtering Condition New Record form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the Condition Script.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the Condition Script. The value, Global, means that the action applies to all applications.</td>
</tr>
<tr>
<td>Description</td>
<td>Explanation of what the Condition Script does.</td>
</tr>
<tr>
<td>Script</td>
<td>Field to enter the JavaScript. Make it returns True to execute a flow. See the next step.</td>
</tr>
</tbody>
</table>

3. Write the Condition Script.
   The key part of these scripts is the conditional statements. If all evaluate true, the script returns True and the flow executes, otherwise it does not. The following example script triggers a flow when a drone is traveling too fast at a low altitude (defined by level 1). The example shows a typical approach to writing a Condition Script.
   a) Get the trigger definition.
   b) Get the record (*current*) that is causing the triggering event.
   c) Get the time from the record that the trigger conditions were satisfied.
   d) Get the trigger level, which defines the trigger parameters.
   e) Use these parameters to return True if the level 1 trigger conditions are met and *travel_state* equals traveling or speeding.

   ```javascript
   function filter(/*GlideRecord*/ triggerDefinition, /*GlideRecord*/ current, /*GlideDateTime*/ start, /*int*/ level) {
     // retrieve current travel state of drone
     var travel_state = String(current.travel_state);

     // the drone is traveling at a significant speed, and the altitude just went below the threshold
     if (((travel_state === 'traveling') || (travel_state === 'speeding'))
         && (level === 1)) {
       return true; //process this trigger
     }

     return false; // don't process this trigger
   }
   ```

   **Note:** Condition Scripts must execute quickly.

4. Click **Submit.**

Use Flow Designer to associate a flow with a trigger. When configuring a flow, you can select a Condition Script you created.
Assign a trigger to a flow

Now that you created a trigger, use Flow Designer to specify the flow a trigger executes. The flows provide alerts for unexpected behavior.

Role required: admin

Triggers, by themselves, execute nothing. After defining a trigger in MetricBase, you use Flow Designer to associate the trigger with a flow.

1. Navigate to MetricBase > Triggers.
   Flow Designer displays a list of triggers associated with Flow Designer flows.
2. Click New > New Flow.

Note: If the list contains triggers, click +New and then New Flow in the list.
3. Enter values for the modal fields and click **Submit**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the flow to execute. The system computes the internal name of the flow from the name.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope to create your flow in. Global is the default.</td>
</tr>
<tr>
<td>Protection</td>
<td>Option to make the flow read-only. Selecting read-only prevents users who do not own the application scope from making changes to the flow. You can only select a value when you create the flow in an application scope you own.</td>
</tr>
<tr>
<td>Description</td>
<td>Explanation of why you are associating this flow with the trigger.</td>
</tr>
<tr>
<td>Run As</td>
<td>Choose whether the flow runs as System User or the user who initiates the session. Use the user who initiates the session option when the update should come from the user who triggered the flow. For example, comments to incident records that should come from the current user, or approval emails that should originate from the approver. Settings on a flow do not apply to child subflows. When run as the user who initiates the session, flow actions are limited by the user’s ACL restrictions. Flows run by the initiating user respect user-specific settings like date/time format.</td>
</tr>
</tbody>
</table>

A tab opens and the tab name is the value for **Name**.

4. Click **Click to add a trigger** to specify the trigger that kicks off this flow. A modal displays that enables you to find and select a trigger type.
5. Scroll and select MetricBase for the trigger type. The Flow Designer form displays.

6. Under TRIGGER, fill in the form to define the trigger to associate with this flow.
   a) Beside MetricBase Trigger, click the magnifying glass to select an existing trigger or click the plus sign (+) to define a new trigger.
   b) Optionally, add requirements for the flow to execute by clicking Add Filter and adding filter conditions, for example, flight-status is-not landed.
   c) Optionally, beside Condition Script, click the magnifying glass to select a condition script or click the plus (+) to create a script.
   Condition scripts add additional requirements for a trigger to execute a flow.
7. Under ACTIONS, click **Click to add an Action, Flow Logic, or Subflow** and select a category in the first column and a flow action in the second column.

8. Click **Done**.

9. Test the flow.
   a) Navigate to **Flow Designer > Designer**, and double-click the flow.
   b) Click **Test**.
      The Test flow dialog box displays. The contents of the Test flow dialog depend on the type of trigger: Data or Schedule. If the trigger is a Data trigger, the dialog asks for a record to use for the test.
   c) Select a record in the dialog box and click **Submit**.

   **Note:** When you test a flow, the system does not execute the trigger, and therefore does not create a new record. By selecting a record in the Test flow dialog box, the system acts as if that record was just created. For more information, see **Test a flow**.
10. Click **Activate** to activate the trigger.
    The flow will not execute unless you activate it.

**Maintain MetricBase**

View the status of MetricBase and debug its triggers.

**View MetricBase status and statistics**

You can view the status of the MetricBase database.

Role required: admin

1. View the status of the MetricBase instance.
   a) Navigate to **System Diagnostics > Stats > Stats**
   b) Scroll down to find **MetricBase Statistics**
2. View the metrics monitored by MetricBase and statistics about them.
   a) Click MetricBase > MetricBase Status
      The MetricBase Status page displays all of the metrics tracked in MB.

      ![MetricBase Status Page]

      b) Click the gear icon.
         The Personalize List Columns modal displays.
c) Select and move metrics from the **Available** column to the **Selected** column to display the metric and click **OK**.

The metrics display on the MetricBase Status page.
View trigger logs

Trigger logs show different levels of trigger malfunctions.

Role required: admin

1. Navigate to MetricBase > MetricBase Triggers > Trigger logs.
2. Click one of the trigger logs.
4. Optional: Change the default values in the Enter parameters for log file entries to browse form to select the log entries to view and click Submit.

Debug MetricBase

You can display the results of debugging scripts in MetricBase.
Role required: admin

1. Navigate to **System Diagnostics** > **Session Debug** > **Debug MetricBase**.
   When the page you are on submits queries to MetricBase, you see the transforms and how long they took on the bottom of the page. Submitting a lot of MetricBase queries may slow down the page load time significantly.

2. To view a history of the debug script's execution, click **available here**.

3. Click **Update**.
   Session debug tracking for MetricBase activities starts and the MetricBase Status page displays.

**Get familiar with MetricBase APIs**

Experiment with MetricBase APIs using Data Explorer that is part of the MetricBase Demo application. Data Explorer uses the data installed with the MetricBase Demo application.

Role required: clotho_admin

Data Explorer is a playground where you can see and edit example scripts that visualize data included with the MetricBase Demo application. The example scripts use the MetricBase JavaScript APIs. For information on the MetricBase JavaScript APIs, see **Client**, **Data**, **DataBuilder**, **Transformer**, **TransformPart**, **TransformResult**.

Example scripts use either:

- Transforms, which use the **Transformer** method.
- Machine Language, trained models that predict expected behavior. All the scripts without "Transform" in their title use Machine Language.

1. Navigate to MetricBase Demo > Data Explorer.
   The Data Explorer displays.

   ![Data Explorer Script Result Display](image)

   ![Data Explorer Script Template](image)

   When you run a script, the data visualization appears under Data Explorer Script Result Display.
2. Select one of the sample scripts to run in the **Example Script** menu.

3. Click **Load Example**.

4. Click **Run**.
   - The script displays the data visualization under **Data Explorer Script Result Display**.

5. Optional: Change the values or statements in the script or write an entirely new script and click **Run**.
   - **Note**: If you want to save the changes you made in the script, click **Save**.

6. Under **Server Output**, look at the server's response that might include error information.
Example scripts

<table>
<thead>
<tr>
<th>Example script</th>
<th>Definition and visualization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Transform</td>
<td>Uses the transformer API to display a single time-series metric, the average speed of the drones: transformer.metric('mb_demo_mt_speed').avg().</td>
</tr>
</tbody>
</table>

![Diagram showing a line graph with time on the x-axis and value on the y-axis. The graph starts at approximately 0:40 and ends at approximately 10:00. The y-axis ranges from 20 to 120.]
<table>
<thead>
<tr>
<th>Example script</th>
<th>Definition and visualization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Transform with Grouping</td>
<td>Uses the transformer API to display a group of time-series metrics, the average altitude of the fleet of the drones:</td>
</tr>
<tr>
<td></td>
<td><code>transformer.groupBy(&quot;fleet&quot;).metric(&quot;mb_demo_mt_altitude&quot;).avg().label('avg - %g:fleet:')</code></td>
</tr>
<tr>
<td>Normal Model</td>
<td>Models normal data, which approximates a bell-shaped or Gaussian curve for distributed values.</td>
</tr>
</tbody>
</table>
### Linear Model

Creates a line to summarize the current data and predict future values. This example, about the remaining charge in drone batteries, graphs both the trained model values and the average of the values.

```javascript
var builder = new sn_clotho.Transformer(drones);
var fit =
    builder.metric("mb_demo_nt_rem_battery").resample(100).
    fit({model:"linear"}).label("Fitted");
builder.metric("nb_demp_mt_rem_battery").avg().label("Original");
```

![Data visualization graph](image-url)
<table>
<thead>
<tr>
<th>Example script</th>
<th>Definition and visualization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seasonal Trend Decomposition Model</td>
<td>Uses a seasonal trend model so that data can be subtracted to reveal non-seasonal trends. This model is similar in purpose to the Holt Winters model but arrives at the result using different algorithms.</td>
</tr>
<tr>
<td>Holt Winters Model</td>
<td>Uses the Holt Winters, seasonal trend model so that data can be subtracted to reveal non-seasonal trends. This model is similar in purpose to the Seasonal Trend Decomposition model but arrives at the result using different algorithms.</td>
</tr>
<tr>
<td>ARIMA Model</td>
<td>The most general class of models for predicting time-series data that has no trend, meaning all the data has the same value or the values fluctuate sinusoidally around the mean.</td>
</tr>
<tr>
<td>Example script</td>
<td>Definition and visualization</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Deviation Model</td>
<td>Uses chi-square model to show the differences between the real data and the model's prediction.</td>
</tr>
<tr>
<td></td>
<td><code>var metric = &quot;nb_demo_mt_rem_battery&quot;;</code></td>
</tr>
<tr>
<td></td>
<td><code>builder.metric(metric).deviation(model, &quot;chiSquare&quot;);</code></td>
</tr>
</tbody>
</table>

### Domain separation and MetricBase

This is an overview of domain separation and the MetricBase application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

#### Overview

**Support: Data only**

Domain separation in this application is supported at the **Data only** level, meaning it supports the data security model of separating visibility of data from one domain to another. To learn more, see Application support for domain separation.

### MID Server

The Management, Instrumentation, and Discovery (MID) Server is a Java application that runs as a Windows service or UNIX daemon on a server in your local network. The MID Server facilitates communication and the movement of data between a ServiceNow instance and external applications, data sources, and services.
The MID Server initiates all communications with the ServiceNow® instance. This communication is recorded as records in the ECC Queue, which acts as the communication log between the instance and the MID Server. The MID Server picks up any work it has to do from the ECC Queue and returns the results of that work to the queue.

This video gives you an overview of the MID Server:

Setting up the MID server

1 Connect
2 Install
3 Configure
4 Encrypt

- Ensure that the MID Server can connect to elements inside and outside your network
- Download and install the MID Server on a Linux or Windows host
- Configure your MID Server
- Configure MID Server security

This documentation provides detailed instructions for setting up a functioning MID Server for use with ITOM applications. Click the icons to go to each task's portal page. These procedures help you prepare your system, download and run the installer, and configure MID Servers to run in your environment. After you get a valid MID Server up and running, you can add security and encryption to protect your data.

At the bottom of each page is a link to the reference materials you need, such as system requirements, configuration parameters, and instructions for monitoring your MID Server. Use the additional link at the bottom to move through the content within a specific category or return to the MID Server setup to access a different portal.

If you are new to the MID Server or an experienced user who wants to set up a MID Server quickly, you can use the MID Server Guided Setup. This wizard walks you through the process of installing and configuring a MID Server with default settings in just a few steps.

Upgrading the MID Server

The MID Server checks with the instance periodically to see if an upgrade is necessary. If the MID Server detects that a new version is available for upgrade, it downloads the installer from install.servicenow.com and runs the package automatically. You can also elect to upgrade the MID Server manually. See MID Server upgrades for details.
Resolving MID Server issues

You can search the HI Knowledge Base for troubleshooting articles or monitor the MID Server status and track active issues from within the instance. See Resolving MID Server issues for details.

ServiceNow applications that use the MID Server

- Discovery
- Orchestration
- Service Mapping
- Event Management
- Operational Intelligence
- Cloud Management

External applications that use the MID Server

- Import Sets
- Microsoft SMS/SCCM
- LANDesk Maintenance Suite
- Microsoft System Center Operations Manager (SCOM)
- Microsoft MIIS

MID Server version compatibility

The version of the MID Server must be compatible with the version of the instance. Otherwise, the MID Server cannot process commands or communicate with the instance.

The instance determines which version of the MID Server is allowed. The MID Server version must at minimum belong to the same major release, such as Madrid. If the MID Server version belongs to the same major release, it can, but does not have to, belong to the same minor version, such as Madrid Patch 1. In this case, communication with the instance might still be possible, but it is always suggested that you upgrade to the latest version.

Caution: You can pin the MID Server to a specific version, but you should be aware that the version might become out of date.

Configure MID Server network connectivity

Prepare the network for MID Servers to connect with the instance and access the download site. The network must be prepared before installing or configuring the MID Server. If computers or devices have additional security measures, that security may interfere with MID Servers on those systems.

Role required: admin
The MID Server host computer must have access to the ServiceNow download site at install.service-now.com to upgrade automatically. If you have a self-hosted ServiceNow environment that blocks access to the download site, you must import the MID Server installer package into your MID Server hosts manually. For instructions, see KB0760123 in the Self-Hosted knowledge base.

The host machine must have these network privileges:

- **Firewall access:** Configure any firewalls between the MID Server and the target devices to allow a connection. If your network uses a DMZ, and if your network security protocols limit port access from within the network to the DMZ, you might have to deploy a MID Server to a machine within the DMZ to probe the devices there.
- **Network access:** Configure target devices to allow the MID Server probe to connect. If network security prevents you from configuring new machines that can connect to the targets, install the MID Server on an existing machine with connection privileges.
- **Network account:** Install the MID Server with the proper account, either local or domain administrator.

Additionally, for the MID Server to access your ServiceNow instance, satisfy these prerequisites:

- **Network access to the ServiceNow instance:** Configure the network that the MID Server uses to allow traffic over TCP port 443.
- **A MID user:** Create a ServiceNow user record for the MID Server to use. This user record must have the mid_server and import_admin roles.

**Note:** Verify that the baseline public page InstanceInfo is active for the MID Server to connect to the instance.

1. Configure the network to allow MID Server network connectivity to the ServiceNow instance over TCP port 443.
2. Configure basic authentication for SOAP communications with the ServiceNow instance.
3. Navigate to System Web Services > Scripted Web Services > Scripted SOAP Services.
4. Confirm that the following web services are active:
   - GetMIDInfo
   - InstanceInfo
   - MIDAssignedPackages
   - MIDFieldForFileProvider
   - MIDFileSyncSnapshot
   - MIDServerCheck
   - MIDServerFileProvider

5. Type `sys_public.list` in the navigation search field and press Enter. The Public Pages record list appears.

6. Verify that the InstanceInfo public page is active, to allow the MID Server to validate its version.

7. Ensure that the MID Server host computer can access the download site at install.service-now.com.

After the network is prepared, proceed to Installing the MID Server.

Prepare network connections for MID Servers

Before you install the MID Server, perform the necessary prerequisites that it needs to connect to elements inside and outside your network. This includes network privileges and security considerations.

Security considerations

Sometimes computers or devices have additional security measures configured, and these measures may interfere with the MID Server’s ability to run commands or queries on those systems.

For example, a Linux server might be configured to allow only certain IP address to connect to it via SSH. Similarly, a network router might be configured to allow only certain IP address to query SNMP on it. To allow access in such cases, use one of the following methods:

- Update the configuration of those computers or devices to allow the desired MID Server to run commands or query them. For example, a network router may be configured to only allow the network management systems to query SNMP on it. In that case, add the MID Server as though it were another network management system.
- Install a MID Server on a computer that already has access to the computers or network devices with such restrictions. For example, to use Discovery within a DMZ (where communication from outside the DMZ will be severely restricted), install a MID Server on a computer that is already in the DMZ.

External connectivity requirements

These requirements are specifically for the use of MID Servers with the ServiceNow® Discovery and Orchestration products.

The MID Server communicates securely on port 443 to the instance and requires no inbound connections. In some cases, it might be necessary to allow this communication through the firewall if the MID Server fails to register on the instance. To determine if the application or a network security restriction is to blame for connection failure, attempt to telnet to the instance on port 443 from the server that is hosting the MID Server application. If this connection fails, then the problem could be a web proxy (since 443 is an https connection) or a Firewall rule preventing external TCP connections from that host. Contact network security personnel for the proxy information to add to the config.xml file, or request that the firewall be configured to allow access using one of the following syntaxes:
• `<source IP>` to `<any>`
• `<source IP>` to `<ServiceNow>` any established
• `<source IP>` to `<instance_name.service-now.com>` 443

**Important:** The MID Server host computer must have access to the ServiceNow download site at `install.service-now.com` to upgrade automatically. If you have a self-hosted ServiceNow environment that blocks access to the download site, you must import the MID Server installer package into your MID Server hosts manually. For instructions, see KB0760123 in the Self-Hosted knowledge base.

### Internal connectivity requirements

These methods are used for discovering various devices on a network and are specifically for the use of MID Servers with the Discovery and Orchestration products.

- **SSH:** For UNIX-like machines, Discovery and Orchestration use SSH protocol, version 2 to access target machines. SSH is a network protocol that allows data to be exchanged using a secure channel between two networked devices. SSH communicates on port 22 within an encrypted datastream and requires a login to access the targets using two available methods of authentication: a user name and password combination and a user name and shared private key. Specify SSH authentication information and type in the **Credentials** module. If multiple credentials are entered, the platform tries one after the other until a successful connection is established or all are ultimately denied. To provide for application relationships a limited number of SUDO commands must be available to be run. Additional details to these requirements can be found in UNIX/Linux commands requiring root privileges for Discovery and Orchestration.

- **WMI:** For Windows machines, Discovery uses the Windows Management Instrumentation (WMI) interface to query devices. Due to security restrictions for WMI, the MID Server application executing the WMI queries must run as a domain user with local (target) administrator privileges. When Discovery detects activity on port 135, it launches a WMI query. The response from the Windows device is sent over a Distributed Component Object Model (DCOM) port configured for WMI on Windows machines. This can be any port. Ensure that the MID Server application host machine has access to the targets on all ports due to the unique nature of the WMI requirements.

- **Windows PowerShell:** PowerShell is built on the Windows .NET Framework and is designed to control and automate the administration of Windows machines and applications. Orchestration uses PowerShell to run Workflow activities on Windows machines. PowerShell must be installed on any MID Server that executes these activities. MID Servers using PowerShell must be installed on a supported Windows operating system. ServiceNow supports PowerShell 2.0 and 3.0. Orchestration activities for PowerShell require a credentials **Type** of Windows.

- **SNMP - Network:** For network devices, Discovery uses an SNMP scan to get device specific MIBs and OIDs. SNMP is a common protocol used on most routers, switches, printers, load balancers and various other network enabled devices. Use a **community string** (password) for authentication when scanning a device via SNMP. Many devices have a default community string of **public** which Discovery uses by default when querying a target. Define additional community strings in the **SNMP credentials** form which are tried in succession, along with **public**, until a successful query returns. In addition to the credentials, the platform also requires the ability to make SNMP requests on port 161 from the MID Server to the target. If Access Control Lists (ACLs) are in place to control the IP addresses that can make these queries, ensure that the IP address of the MID Server is in the ACL. Discovery supports SNMP versions 1, 2c, and 3.

- **WBEM:** Web-Based Enterprise Management (WBEM) defines a particular implementation of the Common Information Model (CIM), including protocols for discovering and accessing each CIM implementation. WBEM requires either of two ports, 5989 or 5988 and uses the HTTP transport protocol. WBEM supports SSL encryption and uses CIM user name/password credentials. Discovery
ServiceNow launches a WBEM port probe to detect activity on the target ports and to append gathered data to a classification probe that explores CIM Servers.

**Installing the MID Server**

Download and install the MID Server on the host machine, test the connection, and then validate the MID Server. Use the manual procedures or the guided setup. Set up multiple MID Servers for load balancing and domain separation. These procedures prepare it for use with any application.

Ensure that the MID Server can connect to elements inside and outside your network.

**MID Server manual installation**

The manual process requires these setup tasks, performed in the order shown here:

1. Create the MID Server user account and grant the appropriate role to this user.
2. Download the installer file for the host machine.
3. Install the MID Server on a Linux or Windows host.
4. Validate the MID Server to ensure that it is trusted to access credentials used by the instance for automations.
5. Test connectivity between the MID Server and the instance for automatic upgrades.
6. Optionally, deploy multiple MID Servers in your network for load balancing or when domain separation is enabled.

**MID Server guided setup**

Alternatively, the MID Server Guided Setup streamlines the process and allows you to set up a basic MID Server quickly.
Create the MID Server user and grant the role

To communicate with the instance, MID Servers need a user ID and the appropriate role. Create the user ID for a MID Server and grant the ID the \textbf{mid\_server} role. To prevent MID Server validation failure, the system runs business rules to monitor the settings selected for MID Server users.

Role required: admin

The MID Server connects to an instance by using the SOAP web service. To allow authentication with the instance, create a separate user account for each MID Server or share the same account across multiple MID Servers. Grant each MID Server user the \textbf{mid\_server} role, which is required for the MID Server user on any instance on which basic authentication is enabled. The \textbf{mid\_server} role allows the MID Server to access protected tables when strict SOAP security is in place. The system adds the necessary SOAP roles automatically with this role.

\textbf{Note:} The strict SOAP security feature, enabled by default for any instance that uses basic authentication, protects all tables with Access Control Lists (ACL).

1. From the instance, navigate to \textbf{User Administration} > \textbf{Users}.
2. Click \textbf{New}.
3. Complete the fields in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>User name for the MID Server user. This name is specified in the \texttt{mid.instance.username} parameter of the configuration file that the MID Server installer creates. For details, see \textbf{MID Server parameters}.</td>
</tr>
<tr>
<td>First name</td>
<td>The user's first name.</td>
</tr>
<tr>
<td>Last name</td>
<td>The user's last name.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password</td>
<td>Password for the MID Server user. This password is specified in the <code>mid.instance.password</code> parameter of the configuration file that the MID Server installer creates.</td>
</tr>
</tbody>
</table>

4. Right-click the header and select **Save**.

5. Under the **Roles** related list, click **Edit**.

6. Select the **mid_server** role for this user.

   Each MID Server account must have this role to access protected tables.

7. Click **Save**.

8. Confirm that the MID Server account was created successfully and the account has connectivity to the instance.

   a) On the host machine where you intend to install the MID Server, open a browser and navigate to the instance.

   b) Use your new MID Server user credentials to log in.

      If the login is successful, then any MID Servers you install on that host will be able to connect to the instance.

### MID Server role validation

Real-time system validation of MID Server role assignments prevents incompatible settings.

To prevent MID Server validation failure and ensure that your MID Server is configured correctly, the system runs several business rules that monitor the roles and settings you select for your MID Server user. The instance displays a warning and blocks the change when you attempt to save an incompatible configuration.

### Elevated privileges not permitted

The mid_server role cannot be configured for elevated privileges. The **Invalid MID Server settings** business rule runs on the Role [sys_user_role] table and prevents the `elevated_privileges` field from being set to true for the mid_server role.
Warning for elevated privileges on the mid_server role

Relationship table protection

The User Role [sys_user_has_role] table creates the relationship between the User [sys_user] and the Role [sys_user_role] tables.

- **Incompatible role**
  The mid_server and security_admin roles are incompatible and cannot be assigned to the same user. The system determines the user's current role and runs the **Security Admin incompatible with MID**
business rule on the User Role [sys_user_has_role] table. This rule prevents an administrator from adding the security_admin role for a user who currently has the mid_server role.

Warnings for incompatible security_admin role assignment

- **Incompatible user role and user record settings**
  
  The **Incompatible MID Server user role** business rule runs on the User Role [sys_user_has_role] table to protect its data from incompatible configurations. Validation for this related table ensures that an administrator cannot assign the mid_server role to a user who already holds the security_admin role.

What to do next

Download the MID Server files for your operating system.

**Download the MID Server files**

Download the MID Server installer package through the instance and make it available for installation on the host. Allow the local network to access the authorized IP addresses to ensure that you can download the installation package and receive automatic upgrades.

Role required: admin
The IP address of the MID Server download site (install.service-now.com) can change without notice. To ensure that you can download the MID Server installation package and receive automatic MID Server upgrades, allow local network access to these IP addresses:

- 149.96.5.98
- 149.96.6.98

**Note:** Download the MID Server first and then enable Discovery, Orchestration, or any integration that requires the use of the MID Server.

1. On the ServiceNow instance, navigate to **Mid Server > Downloads**.
2. Select and download the MID Server for the appropriate operating system. For the best performance, install the 64-bit MID Server for your operating system.

**Note:** ServiceNow will discontinue support for 32-bit MID Servers in a future release.

### MID Server downloads

3. Save the download file to a temporary file on the local drive.
4. Move the file into the designated MID Server folder you create for your operating system and run the installer from that location.

You can manually verify the signature of an installation package with the jarsigner tool to ensure its authenticity. For more information about verifying the signature, see the **MID Server upgrades** section on manual verification.

Then, install the MID Server on the host computer.

- **Linux**
• Windows

Install a MID Server on Linux

Install MID Servers with the MID Server installation package and verify it is active. The package includes an installer that automatically configures OpenJDK to run in the environment. The MID Server can use an existing JRE rather than the provided OpenJDK. Uninstall the MID Server to redeploy it.

Verify that the host computer satisfies the MID Server system requirements.

Role required: admin, mid_server

OpenJDK version 1.8.0_231 is bundled with the MID Server installer package and is installed on the host for all new MID Servers. See the HI Knowledge Base article KB0719830 for more information on OpenJDK version support. The installer automatically configures OpenJDK to run in your environment. No additional configuration is required. This version supports both 32-bit and 64-bit MID Servers. For the best performance, install the 64-bit MID Server for your operating system. The MID Server requires a minimum JRE version 1.8.0_161, and recommended version 1.8.0_231. If you are using a lower version than 1.8.0_161, you may see encryption related issues.

Note: ServiceNow will discontinue support for 32-bit MID Servers in a future release.

Testing showed that the MID Server works as expected with Oracle Java 11 version 11.0.5 and Oracle JRE 8 version 1.8.0_231. However, Oracle JRE 8 version 1.8.0_231 requires the workaround described in the HI Knowledge Base article MID Server running Oracle JRE version 8 [KB0784442]. In order to use Java 11 on Windows MID Servers, refer to Install Java 11 on Windows MID servers [KB0752451].

Upgraded MID Servers might use different Java versions depending on their release level.

• MID Servers upgraded from Kingston and earlier use the OpenJDK provided with the MID Server installer. This version of the OpenJDK was tested and certified for use with these MID Servers.
• MID Servers upgraded from London continue to use the same JRE you configured for London. The MID Server supports JRE 1.8.
Click this link to view the installation video:

1. From the Linux command line, type `mkdir -p /servicenow/mid server name` to create the installation directory. You need to have read/write/execute permissions on this folder.

2. Extract the downloaded MID Server archive file, `mid.os.zip` into the `servicenow/mid server name` directory. Use the MID Server name created in the instance or create a new name that you will use for this MID Server moving forward.

   The resulting directory structure is `/servicenow/<mid server name>/agent`.

3. Change to the `servicenow/mid server name /agent` directory, and enter the following command to start the MID Server installer: `./installer.sh`.

   If you prefer to manually configure the MID Server instead, skip to step 13.
4. Use the installer to enter the following information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow instance URL</td>
<td>Enter the full URL of your instance, for example:</td>
</tr>
<tr>
<td></td>
<td>https://(inst.name).service-now.com/</td>
</tr>
<tr>
<td>ServiceNow MID Server username</td>
<td>midserver</td>
</tr>
<tr>
<td>ServiceNow MID Server password</td>
<td>.................................</td>
</tr>
<tr>
<td>Use proxy</td>
<td></td>
</tr>
<tr>
<td>Proxy host</td>
<td>proxyserver.domain.com</td>
</tr>
<tr>
<td>Proxy port</td>
<td>3238</td>
</tr>
<tr>
<td>Proxy username</td>
<td>proxyuser</td>
</tr>
<tr>
<td>Proxy password</td>
<td>.................................</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow MID Server username</td>
<td>Enter the user name of the MID Server user that you already created. The MID Server user must have the mid_server role.</td>
</tr>
<tr>
<td>ServiceNow MID Server password</td>
<td>Enter the password for the user in the ServiceNow MID Server username.</td>
</tr>
<tr>
<td>Use proxy</td>
<td>Select this check box if your MID Server communicates through a proxy to connect to the instance.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Your proxy server must use Basic Authentication for the MID server to connect to the instance.</td>
</tr>
<tr>
<td>Proxy host</td>
<td>Enter the proxy server host name or IP address. Do not include the protocol in the host name. For example, enter proxyserver.domain.com, not <a href="https://proxyserver.domain.com">https://proxyserver.domain.com</a>.</td>
</tr>
<tr>
<td>Proxy port</td>
<td>Enter the port through which the proxy server communicates. If you leave this field blank, it should use the proxy server's default port number.</td>
</tr>
<tr>
<td>Proxy username</td>
<td>Enter the user name that has administrator rights to the proxy server.</td>
</tr>
<tr>
<td>Proxy password</td>
<td>Enter the password for the user name.</td>
</tr>
</tbody>
</table>

5. Click **Test your connection** to validate the credentials and instance information. If you encounter any errors, verify the information that you input.

6. Click **Next**.
7. Configure the MID name parameters (see table).
   The wrapper settings are not applicable for Linux operating systems and are disabled for this installation.
Configure MID Name Parameters

*MID Server name: My/Linux_mid_server
MID service wrapper name: snc_mid
MID service wrapper display name: ServiceNow MID Server

Wrapper settings have been disabled as they are not being used for this OS.

View Installer Logs
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server name</td>
<td>Enter a MID Server name. <strong>Caution:</strong> MID Server names cannot begin with <code>mid.server</code>.</td>
</tr>
<tr>
<td>MID Service wrapper name</td>
<td>Modify this field if necessary. It is populated automatically by prefixing <code>snc_mid_</code> to the MID Server name. In most cases, you do not need to modify this.</td>
</tr>
<tr>
<td>MID Server wrapper display name</td>
<td>Modify this field if necessary. It is populated automatically by prefixing <code>ServiceNow MID Server_</code> to the MID Server name. In most cases, you do not need to modify this.</td>
</tr>
</tbody>
</table>
8. Click **Next** to view the summary.
Your MID Server has been successfully configured!

To begin using the MID Server:

1. Click Start MID Server.
2. Click MID Servers List Page. It may take a few seconds for your MID Server to appear.
3. Click on the record for "My_Linux_mid_server" then click Validate under Related Links.

For installation details, you may check the log files at: /agent
9. Click **Start MID Server**.
   The local host starts the MID Server.
   When the MID Server service starts, it verifies that it is the only active (not down) MID Server with that name. If the MID Server discovers another active MID Server with the same name, the starting MID Server waits 5 minutes and sends another query. The MID Server repeats this query three times and logs each attempt in the agent log. If the MID Server still detects a duplicate after this cycle, it creates a record in the MID Server Issue [ecc_agent_issue] table and shuts down.

   **Note:** The record in the MID Server Issue [ecc_agent_issue] table cannot be resolved automatically by the instance. Close this record manually for accounting purposes. Either mark the issue **Resolved** or delete it.

10. Click **Mid Servers List Page**.
    The installer opens the MID Server list from your instance.

11. Select the MID Server name from the list.

   **Note:** It may take a few seconds for the MID Server time to establish a connection with your instance.

   The system displays the MID Server record.

12. From **Related Links**, click **Validate**.
    The MID Server **Validated** changes to **Yes**.

13. To configure the MID Server manually, change to the servicenow/mid server name /agent directory, and then edit the config.xml file as follows:
   a) Find the element `<parameter name="url" value="https://YOUR_INSTANCE.service-now.com" />` and change the value to the URL of your instance.
   b) Enter the MID user credentials in the `mid.instance.username` and `mid.instance.password` parameters.
      By default, the MID Server uses basic authentication for SOAP messages. The password value is also encrypted authentication.
   c) Find the `<parameter name="name" value="YOUR_MIDSERVER_NAME_GOES_HERE" />` element and change the value for the MID Server name.
   d) Optional: Enter connection information for the proxy server. Remove the appropriate comment tags from the proxy configuration information.
      For example, you can configure these parameters:
      - `mid.proxy.use_proxy`
      - `mid.proxy.host`
      - `mid.proxy.port`
      - `mid.proxy.username`
      - `mid.proxy.password`
14. Start the MID Server and verify that it is active.
   a) In the MID Server home directory (agent), execute the shell script start.sh to start the new MID Server.
   b) Log into the instance and navigate to MID Servers > Servers to verify that your new MID Server has a Status or Up.
      Additional log information appears here:
      • The MID Server log on the instance.
      • The corresponding agent0.log.0 and wrapper logs (wrapper.log) in the MID Server agent/logs folder.

15. To configure the MID Server to restart automatically when the host is restarted, run
   ${{base_install_dir}}/agent/bin/mid.sh install as root.
   This command installs the MID Server as a daemon service and adds the auto start scripts to the init.d directory.

   Note: You cannot install more than one MID Server service as a daemon on a Linux host. This is a limitation of the Tanuki wrapper service.

16. To stop the MID Server, navigate to the MID Server home (agent) directory and execute the stop.sh shell script.

17. To restart a stopped MID Server, navigate to the MID Server home (agent) directory and execute the restart-service.sh script, using one of these commands:
    • ./restart-service.sh
    • sh restart-service.sh
    • bash restart-service.sh

Configure a Linux MID Server to use an existing JRE

You can choose to use an existing JRE for your MID Server rather than the OpenJDK provided with the MID Server installer.

Ensure that your JRE version is supported. See MID Server system requirements for details.

Role required: admin

By electing to use your own JRE, you are responsible for upgrading it as necessary. For a detailed procedure and cautions regarding changing the JRE, see KB0778272.

1. Navigate to this file in the MID Server installation directory:
   agent/conf/wrapper-override.conf

2. To specify the existing Java executable that you want to use, add this line to the file:
   wrapper.java.command={your_java_executable}

   For more information, see the Java service wrapper property documentation.

3. Save the file.

Uninstall a Linux MID Server

The MID Server runs as a stand-alone service. You can remove a stand-alone MID Server service to accommodate such tasks as redeploying the MID Server to another host machine or changing the unique name of a MID Server when deploying multiple MID Servers.
Role required: admin

1. To stop the running MID Server service, navigate to the MID Server home (agent) directory and run `stop.sh`.
2. From a command prompt, go to the \agent\bin directory in the MID Server installation directory.
3. Confirm that the MID Server is stopped by executing the `bin/mid.sh status` shell script.
4. After the MID Server stops, delete the files in the agent directory.

Validate the MID Server to prepare it for use.

Install a MID Server on Windows

Install MID Servers with the MID Server installation package and verify it is active. The package includes an installer that automatically configures OpenJDK to run in the environment. The MID Server can use an existing JRE rather than the provided OpenJDK. Uninstall the MID Server to redeploy it.

- Verify that the host computer satisfies the MID Server system requirements.
- The MID Server requires the minimum PowerShell version 3.0 and supports versions up to PowerShell 5.1.
- Ensure that the Microsoft Application Experience Lookup Service is enabled on the MID Server host. If this service is disabled, the MID Server auto-upgrade might fail, causing the MID Server to go down. For information on managing issues with the Application Experience service, see KB0597552.

**Note:** PowerShell version 2.0 is not supported, therefore it is recommended to upgrade to a higher version. If the detects that it has version 2.0, it may work partially. The creates a record in the mid_server issue table with the following message: PowerShell version 2 is deprecated. Upgrading PowerShell to version 5 is recommended.

Role required: admin or mid_server

OpenJDK version 1.8.0_231 is bundled with the MID Server installer package and is installed on the host for all new MID Servers. See the HI Knowledge Base article KB0719830 for more information on OpenJDK version support. The installer automatically configures OpenJDK to run in your environment. No additional configuration is required. This version supports both 32-bit and 64-bit MID Servers. For the
best performance, install the 64-bit MID Server for your operating system. The MID Server requires a minimum JRE version 1.8.0_161, and recommended version 1.8.0_231. If you are using a lower version than 1.8.0_161, you may see encryption related issues.

Note: ServiceNow will discontinue support for 32-bit MID Servers in a future release.

Testing showed that the MID Server works as expected with Oracle Java 11 version 11.0.5 and Oracle JRE 8 version 1.8.0_231. However, Oracle JRE 8 version 1.8.0_231 requires the workaround described in the HI Knowledge Base article MID Server running Oracle JRE version 8 [KB0784442]. In order to use Java 11 on Windows MID Servers, refer to Install Java 11 on Windows MID servers [KB0752451].

Upgraded MID Servers might use different Java versions depending on their release level.

- MID Servers upgraded from Kingston and earlier use the OpenJDK provided with the MID Server installer. This version of the OpenJDK was tested and certified for use with these MID Servers.
- MID Servers upgraded from London continue to use the same JRE you configured for London. The MID Server supports JRE 1.8.

Click this link to view the installation video:

1. Log in to the Windows host machine where you want to install the MID Server.
2. Create a folder for the MID Server on the top level of the drive such as ServiceNow\MID Server1.
3. Download the MID archive file into the new folder.
4. Right-click the archive and select Extract All.
5. Navigate to the service-now\<mid server name>\agent folder that was created when the file was extracted.
6. Run installer.bat to start the MID Server installer.

To configure the MID Server manually, skip to step 16.
7. Use the installer to enter the following information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow instance URL</td>
<td>Enter the full URL of your instance, for example: <a href="https://mycompanyinstance.service-now.com">https://mycompanyinstance.service-now.com</a></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ServiceNow MID Server username</td>
<td>Enter the name of the MID Server user that you already created. The MID Server user must have the mid_server role.</td>
</tr>
<tr>
<td>ServiceNow MID Server password</td>
<td>Enter the password for the user in the ServiceNow MID Server username.</td>
</tr>
<tr>
<td>Use proxy</td>
<td>Select this check box if your MID Server communicates through a proxy to connect to the instance.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Your proxy server must use Basic Authentication for the MID server to connect to the instance.</td>
</tr>
<tr>
<td>Proxy host</td>
<td>Enter the proxy server host name or IP address. Do not include the protocol in the host name. For example, enter proxyserver.domain.com, not <a href="https://proxyserver.domain.com">https://proxyserver.domain.com</a>.</td>
</tr>
<tr>
<td>Proxy port</td>
<td>Enter the port through which the proxy server communicates. If you leave this field blank, it should use the proxy server's default port number.</td>
</tr>
<tr>
<td>Proxy username</td>
<td>Enter the user name that has administrator rights to the proxy server.</td>
</tr>
<tr>
<td>Proxy password</td>
<td>Enter the password for the user name.</td>
</tr>
</tbody>
</table>

8. Click **Test your connection** to validate the credentials and instance information. If you encounter any errors, verify the information that you input.

9. Click **Next**.
10. Configure the MID name parameters (see table).
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server name</td>
<td>Enter a MID Server name.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution:</strong> MID Server names cannot begin with mid.server.</td>
</tr>
<tr>
<td>MID Service wrapper name</td>
<td>Modify this field if necessary. It is populated automatically by prefixing snc_mid_ to the MID Server name. In most cases, you do not need to modify this.</td>
</tr>
<tr>
<td>MID Server wrapper display name</td>
<td>Modify this field if necessary. It is populated automatically by prefixing ServiceNow MID Server_ to the MID Server name. In most cases, you do not need to modify this.</td>
</tr>
</tbody>
</table>
11. Click **Next** to view the summary.

Your MID Server has been successfully configured!

To begin using the MID Server:
1. Click **Start MID Server**.
2. Click **MID Servers List Page**. It may take a few seconds for your MID Server to appear.
3. Click on the record for "My_Windows_mid_server" then click **Validate** under Related Links.

For installation details, you may check the log files at: C:\agent\
12. Click **Start MID Server**.
The local host starts the MID Server.

   **Note:** If the MID Server fails to start, the cause might be a duplicate name or multiple services that point to the same executable path. See MID Server fails to start for details.

13. Click **Mid Servers List Page**.
The installer opens the MID Server list from your instance.

14. Select the MID Server name from the list.

   **Note:** It may take a few seconds for the MID Server time to establish a connection with your instance.

The system displays the MID Server record.

15. From **Related Links**, click **Validate**.
The MID Server **Validated** changes to **Yes**.

16. To configure the MID Server manually, edit the `config.xml` file with a text editor such as WordPad:
   a) Find the element `<parameter name="url" value="https://YOUR_INSTANCE.service-now.com" />` and change the value to the URL of your instance.
   b) Enter the MID user credentials in the `mid.instance.username` and `mid.instance.password` parameters.
      By default, the MID Server uses basic authentication for SOAP messages. The password value is also encrypted authentication.
   c) Optional: Find the `<parameter name="name" value="YOUR_MIDSERVER_NAME_GOES_HERE" />` element and change the value for the MID Server name.
   d) Optional: Enter connection information for the proxy server. Remove the appropriate comment tags from the proxy configuration information.
      For example, you can configure these parameters:
      • `mid.proxy.use_proxy`
      • `mid.proxy.host`
      • `mid.proxy.port`
      • `mid.proxy.username`
      • `mid.proxy.password`

17. Start the MID Server and verify that it is active.
   a) In the MID Server home directory (`agent`), execute the batch file `start.bat` to start the new MID Server.
   b) Log into the instance and navigate to **MID Server > Servers** to verify that the **Status** of your new MID Server is **Up**.
      Additional log information appears here:
      • The MID Server log on the instance.
      • The corresponding `agent0.log.0` and wrapper logs (`wrapper.log`) in the MID Server `agent/logs` folder.

18. To stop the MID Server, use either of these procedures:
   • **Windows command line:** From the MID Server home directory (`agent`) run `stop.bat`.
   • **Windows Services console:** Right click **ServiceNow <MID Server name>**, and then select **Stop**.
19. To restart a stopped MID Server, use either of these procedures:
   • **Windows command line**: In the MID Server home directory (agent),
   • **Windows Services console**: Right click ServiceNow `<MID Server name>`, and then select **Start**.

## Configure Windows MID Server service credentials

Mid Server service credentials are required to manage the MID Server service on the host machine, including its ability to successfully auto-upgrade.

By default, the MID Server service runs as a **Local System** account. This account has privileges to create and run the MID Server service and to download, create, and move files for the MID Server auto-upgrade process.

Windows service credentials are not the same as the MID Server user credentials, which allow communication between the MID Server and the instance. You must configure both of these credentials separately. See Create the MID Server user and grant the role for instructions on MID Server user credentials.

**Attention**: This procedure is optional. Allowing the MID Server service to run as a Local System account is sufficient for a majority of users.

1. Open the Windows Services console.
2. Double-click the **ServiceNow <MID Server name>** service for each MID Server.
3. Select the **Log On** tab.
4. Set **Log on as** privileges with the user account (local or on a domain) that has local admin access to the MID Server host.
   - The MID Server upgrade process deploys a temporary Windows service which requires local administrator privileges.
5. In the **General** tab, set the **Startup type**.
   - The field is set to **Automatic** by default.
6. Click **OK**.
7. Restart the **ServiceNow <MID Server name>** service, and make sure that **ServiceNow\<MID Server name>\agent\logs\agent0.log** does not have error messages. If the MID Server does not start, see the ServiceNow knowledge article Review the agent log for MID Server errors (article KB0535148).
8. On the instance to which this MID Server is connected, navigate to **MID Server > Servers**. If Discovery is installed, alternately navigate to **Discovery > MID Servers**.
   - All MID Servers connected to this instance are listed.
9. Make sure that the Status of the MID Server you just installed is **Up**.

## Manually install a MID Server as a Windows Service

If you did not start the MID server at the end of the installation procedure, you can manually install the MID Server to run as a Windows service.

**Role required**: admin

You can install a MID Server as a Windows service in these operating systems:
   • Windows Server 2008
   • Windows Server 2012
   • Windows Server 2016
• Windows Server 2019

1. Open the agent directory in the directory you created for the MID Server installation files. For example, the path might be C:\ServiceNow\MID Server1\agent.
2. Right-click the start.bat file, and select Properties.
3. Select the option to Run as administrator.
4. Double-click the start.bat file to install the Windows service.

Configure a MID Server on Windows to use an existing JRE

You can choose to use an existing JRE for your MID Server rather than the OpenJDK provided with the MID Server installer.

Ensure that your JRE version is supported. See MID Server system requirements for details.

Role required: admin

By electing to use your own JRE, you are responsible for upgrading it as necessary. For a detailed procedure and cautions regarding changing the JRE, see KB0778272.

1. Navigate to this file in the MID Server installation directory:
   agent/conf/wrapper-override.conf
2. To specify the existing Java executable that you want to use, add this line to the file:
   wrapper.java.command={your_java_executable}
   For more information, see the Java service wrapper property documentation.
3. Save the file.

Uninstall a Windows MID Server

The MID Server runs as a stand-alone service. You can remove a stand-alone MID Server service to accommodate such tasks as redeploying the MID Server to another host machine or changing the unique name of a MID Server when deploying multiple MID Servers.

Role required: admin

1. Stop the running MID Server service, using either of these procedures:
   • Windows command line: From the MID Server home (agent) directory, run stop.bat.
   • Windows Services console: From the Windows Services console, right-click the ServiceNow MID Server name and then select stop.

2. From a command prompt, go to the \agent\bin directory in the MID Server installation directory and double-click the UninstallMID-NT.bat file.
3. Check the Windows Services console for a service named ServiceNow WMI Collector. If the service is running, open a command prompt, navigate to agent\bin\sw_wmi\tools, and double-click uninstall_wmi.bat

Validate the MID Server to prepare it for use.

Validate the MID Server

You must manually validate the MID Server after it is installed to enable it to execute automation tasks. You can invalidate a MID Server you suspect has been compromised to prevent it from accessing automation credentials in the instance or executing outbound ECC probes.

Role required: agent_admin, admin
Make sure that the MID Server version is compatible with the instance.

Validation restricts access to automation credentials to trusted MID servers only.

You can specify that the MID should be used for all capabilities, applications, and IP ranges when you validate a MID Server. You will be prompted to set the initial selection criteria when you validate MID Servers that do not already have capabilities, applications, or IP ranges already configured. You do not have to set the initial selection criteria to actually validate the MID Server. See MID Server selection for more information on capabilities, applications, and IP ranges.

Note: When you upgrade, MID Servers that are already configured in your instance are automatically validated. This prevents the interruption of automation tasks that MID Servers might be performing. See MID Server upgrades for more information.

1. Navigate to MID Server > Servers.
2. Open the new MID Server you created from the list of MID Servers.
3. Under Related Links click Validate.
   The Set Initial Selection Criteria window appears if there are no records in the Supported Applications, IP Ranges, or Capabilities related lists.
4. On the Set Initial Selection Criteria window, use the switches to enable or disable selection criteria for this MID Server:

- **Allow ALL capabilities**: Allow all capabilities for Orchestration and Event Management to use this MID Server.

  Note: Service Mapping and Event Management alert aggregation and RCA, which used capabilities in previous releases, rely on the application for MID Server selection.

- **Allow ALL applications**: Allow all applications that use MID Servers to use this MID Server.

- **Allow ALL IP ranges**: Make all IP ranges valid for this MID Server, meaning that it can target any IP address.

5. Click **OK**.

   The **Validated** field on the dashboard is set to **Validating**, and then set to **Yes** after the validation completes.

6. To invalidate a MID Server, open the record for the MID Server you suspect has a security issue.

7. Under **Related Links**, click **Invalidate**.

   Invalidating a MID Server forces it to clear its memory and restart. The MID Server generates a new keypair on restart.

Test network connectivity to ensure that the MID Server can upgrade automatically.

**Test MID Server connectivity**

Confirm that the MID Server host is able to communicate with the instance. Resolve any issues with the network connectivity such as conflicts with firewalls, access control lists, and routing errors. Successful communication is necessary for automatic upgrades.

Role required: admin
The computer that hosts the MID Server must be able to access one of these URLs to upgrade automatically:

- **HTTPS**: https://install.service-now.com on the default HTTPS port (443)
- **HTTP**: http://install.service-now.com on the default HTTPS port (80)

1. Use PING to test connectivity with the host on the network (ping<host IP>).
2. If no ping response is returned, use TRACEROUTE to see where traffic might be stopped (traceroute<host>).
3. Use TELNET to connect to any of the TCP ports (telnet<host> <port>).
4. Use an SNMP scanning tool to determine if a potential network device is responsive.
5. Resolve the most likely issues around network connectivity:
   - **Routing**: Confirm that the MID Server host has network access to the IP ranges you are attempting to discover.
   - **Firewalls**: Confirm access to the physical firewalls that protect a large environment such as the Data Center. Confirm access to any logical firewalls that protect an individual computer. MID Server communications are initiated inside the firewall and therefore do not require any special firewall rules or VPNs.
   - **Access Control Lists (ACL)**: Confirm that ACLs contain the IP addresses based list on SNMP network devices that allows communication to a particular target.
   - **Resolve all issues with your network teams to better understand your topology.** Deploy additional MID Servers if necessary to help keep your network secure. Configure access from your existing MID Server host to networking components.

6. Verify that the MID Server service is running on the host:
   - **Windows**: In the Windows Services console, locate the ServiceNow [MID Server name] and confirm that each MID Server has the **Started Status** value.
   - **Linux**: Ensure that the agent0.log.0.lck appears in the /servicenow/ MID Server name]/agent folder.

7. After each MID Server restart, open the agent0.log.0 and address all error messages.
8. From the ServiceNow instance, navigate to MID Server > Servers.
9. Review and verify that all MID Servers that are connected to the instance are listed.
10. Verify that the **Status** is **Up** for the MID Servers.

This concludes the installation of a single MID Server. If necessary, continue to **deploy multiple MID Servers from a single host** in your network. Otherwise, begin **configuring your MID Server**.

**Install multiple MID Servers on a single system**

Install multiple MID Servers on the same host computer. Multiple MID Servers can support each other with load balancing, as well as use domain separation. The number of MID Servers required is determined by factors like network policies, security restraints, and the reliability of the host computer.

Role required: admin, mid_server

---

Important: Only one MID Server service can be a daemon on a Linux host. This is a limitation of the Tanuki wrapper service.

---

You can install multiple MID Servers on a Linux or Windows host or on a virtual machine. Installing multiple MID Servers may involve other setup steps depending on your network configuration.

1. Log in to the host system or virtual machine where you want to install multiple MID Servers.
2. Create a directory for each MID Server on the top level of the drive.
   
   Make sure you create a unique and descriptive name for each MID Server, such as MIDSerV3_SMS_It1 or MIDSerV3_SerV3_Disc1.
3. Extract the downloaded MID Server archive file into each MID Server directory. When the extract completes, there should be a directory path similar to the following for each MID Server: `ServiceNow<MID Server name>\agent`.
4. For each MID Server, run the installer appropriate to the host's operating system.

**MID Server installers**

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Installer path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>/agent/installer.bat</td>
</tr>
</tbody>
</table>
5. Use the installer to enter the following information.

- URL to your instance
- User credentials to run the MID Server
- Proxy server connection details
- MID server name
- MID server service wrapper name and display name (Windows systems only)

<i>Note: The MID Server user must have the mid_server role.</i>
6. From the installer, click **Start MID Server**.

   ![Start MID Server button]

   The local host starts the MID Server.

7. Click **Mid Servers List Page**.

   The installer opens the MID Server list from your instance.
8. Select the MID Server name from the list.

**Note:** It may take a few seconds for the MID Server time to establish a connection with your instance.

The system displays the MID Server record.


The MID Server Validated changes to Yes.

All MID Server installation procedures are complete. Proceed to configure your MID Server.

**Multiple MID Server deployments**

Depending upon how you use the MID Server (for an external integration, Discovery, Service Mapping, or Orchestration) and the load placed on it, you might find it necessary to deploy multiple MID Servers in your network.

Factors determining the number of MID Servers your network will require to support external applications that integrate with ServiceNow include the following:

- The security constraints in your network.
- Your network policies.
- The amount of traffic between ServiceNow and the integrations.
- The reliability of the MID Server machines.

**Network policies and security**

Security policies in your network (firewalls between network segments, for example) might make direct communication impossible between your instance and an integration's data source (JDBC, LDAP, etc.). To retrieve data for the instance, you can install a MID Server that has access to both the data source and the instance.

These network policies can determine if you need to install multiple MID Servers in your environment:

- **Access control lists (ACL):** If your security policy controls access to network devices (e.g. switches and routers) with an ACL, it might be necessary to install one or more MID Servers on a machine in the network that is already on the ACL.
- **DMZ:** Your network policy might require you to install one or more MID Servers in your DMZ to probe the devices there. This is common in networks that tightly regulate the ports that are opened on the inside firewall.
- **Probe types:** If you are conducting probes of different operating systems, your network policy might require a separate MID Server for each type of probe (e.g., one MID server for Windows WMI probes and another for SSH probes on UNIX).

**Load balancing**

Deploy multiple MID Servers where capacity is an issue, as when Discovery has to gather information about thousands of configuration items quickly. In a high volume environment, it might be necessary to deploy multiple MID Servers as load balancers for certain transactions. For example, JDBC data transfers can tie up the resources of a MID Server, making it unable to respond to other requests. The following operations between an integration might require separate MID Servers in a busy network:

- File exports
- Running scripts
• JDBC data sources
• Reading files

High availability model

Avoid installing MID Servers for critical integrations on a machine that might experience any type of planned outage or an outage caused by overloaded processes. If necessary for reliability, consider deploying these types of MID Servers to dedicated machines for high reliability.

Note: Do not integrate with an external application on a MID Server provisioned for ServiceNow Discovery or Orchestration.

Wide area network (WAN)

When determining where to deploy MID Servers in a WAN, consider the bandwidth available between your local area networks. In most cases, install a MID Server on each LAN to probe devices locally, rather than deploying MID Servers that must probe devices across slow WAN connections. An alternative to this type of deployment is to install MID Servers that probe other LANs via VPN connections that take advantage of fast Internet connections. If the bandwidth of your WAN connections is comparable to that of your Internet connection, then there is no performance impact in running MID Server probes across WAN connections.

Domain separation

In deployments where domain separation is enabled and domains are configured to form a hierarchy, place the MID Servers at the lowest domain level.
Deploying MID Servers with domain separation

Use MID Server guided setup

MID Server guided setup provides a sequence of tasks that help you install a MID Server with the proper user account and validate the MID Server. If you are setting up a MID Server for the first time, this is a good way to get one up and running in your environment quickly.

Role required: admin
You are guided through a series of configuration activities that create a fully qualified MID Server. A progress indicator on each screen allows you to monitor your progress on each task.

Each configuration activity provides the following resources to help you:

- Contextual embedded help.
- Links to comprehensive documentation on the ServiceNow product documentation site.

**Important:** You must complete MID Server configuration before you can launch any other IT Operations Management guided setup.

1. Navigate to **Guided Setup > ITOM Guided Setup**.
   - The IT Operations Management Guided Setup welcome screen appears.
2. Take one of the following actions:
   - If none of the MID Server installation and configuration tasks are complete, click **Get Started**.
   - If you have completed any of the MID Server installation and configuration tasks, click **Continue** to return to the task list.
   - Select the MID Server icon in the progress bar on the left side of the category screen to display the MID Server category pane at any time.

   ![Continuing MID Server guided setup from the progress bar](image)

3. Click **Continue**.
   The IT Operations Management Guided Setup category screen appears. The controls for starting the MID Server tasks are at the top of the list. These tasks must be completed before you can set up the other applications that rely on the MID Server.
4. In the MID Server pane, click **Get Started**.
   The MID Server task list appears with a description of each task.
The MID Server runs as a Windows service or a UNIX daemon to facilitate communication and the movement of data between a ServiceNow instance and external applications, data sources, and services. Complete the activities in this category to create a user for the MID Server, download the installation package, and validate the MID Server after installation.

**Create MID User**

Create the user account that the MID Server needs to authenticate on the ServiceNow instance.

**Download & Install MID**

Select and download the appropriate MID Server installer archive for the operating system.

**Validate MID**

You must validate the network connection between the MID server and your instance before the MID server is permitted to access automation credentials or execute any outbound SDC probes.
5. Click **Configure** to create the MID Server user and follow the instructions in the help pane that appears on the right side of the screen.

**Attention:** If you configured MID Servers manually prior to starting Guided Setup, select from that information to complete each specific task.

6. When you have provided the requested information for the MID Server user, click **Submit**, and then click **Mark as Complete** at the bottom of the help pane.

The view returns to the task list. Notice that the circular progress indicator for the category shows 33% of the MID Server configuration complete. The progress indicator on the left side of the screen shows the completion percentage for all the IT Operations Management tasks.

7. Click **Configure** for the next task, **Download & Install MID**.

OpenJDK version 1.8.0_231 is bundled with the MID Server installer package and is installed on the host for all new MID Servers. See the HI Knowledge Base article [KB0719830](http://example.com) for more information on OpenJDK version support. The installer automatically configures OpenJDK to run in your environment. No additional configuration is required. This version supports both 32-bit and 64-bit MID Servers. For the best performance, install the 64-bit MID Server for your operating system. The MID Server
requires a minimum JRE version 1.8.0_161, and recommended version 1.8.0_231. If you are using a lower version than 1.8.0_161, you may see encryption related issues.

**Note:** ServiceNow will discontinue support for 32-bit MID Servers in a future release.

8. Validate your new MID Server.

If necessary, deploy multiple MID Servers from a single host in your network. Otherwise, proceed to configure your MID Server.

### Configuring MID Servers

After installing and validating your MID Servers, ensure that they have access to sufficient system resources, probe the proper targets, and communicate with the instance as expected. Configure MID Server selection criteria, create clusters for failover protection, and set up MID Servers in different domains to protect data.

Some of these configuration procedures rely on data found in the MID Server references home page. See that page for links to the parameters, properties, and privileged commands you need to fine tune the behavior of your MID Servers. You can apply controls to individual MID Servers or to all the MID Servers in your environment. Remember to restart the MID Server after any configuration change for those changes to take effect.

### MID Server selection

MID Servers are selected for use based on three criteria: applications, IP address or range, and capabilities. You can designate specific applications for a given MID Server, such as Discovery or Orchestration. You can specify an IP address or a range that a MID Server is allowed to work within. Some applications require specific capabilities, and so are restricted to MID Servers with those capabilities.

Configure the way your instance selects a MID Server, either by application, IP address ranges, network capability, or behavior.
MID Server capabilities
Create capabilities that define the specific functions of a MID Server within an IP address range.

MID Server IP range auto-assignment
Configure the system to automatically assign a qualified MID Server to a subnet by that subnet's IP address range.

Map an IP address to a DNS name
Map host server DNS names to IP addresses if your MID Server manages resources within defined IP ranges.

Configure MID Server as WinRM trusted host
Add servers, which are part of WinRM, as trusted hosts on all MID Servers that Discovery or Service Mapping use for discovery.

MID Server clusters
MID Server clusters are groups of MID Servers which provide support to each other in the forms of load balancing and fail-over protection. Work sent to a MID Server that is part of a cluster is automatically balanced between all the MID Servers in that cluster. MID Servers in a fail-over cluster each have a configured order that the platform uses to determine which MID Server to use next in case of failure.

Create a MID Server cluster
Create a MID Server cluster for load balancing and fail-over protection.

Set thread use
Set the number of threads your MID Server uses for the desired MID Server speed, based on hardware capabilities and competing applications running on the host.

Domain separation
Domain separation segregates MID Servers based on the records they can access. The credentials configured in a MID Server's config.xml file determine which records that MID Server can read, update, or create. You can specify MID Server policy records that only MID Servers from the same domain can use.

MID Server domain separation
Set up your MID Servers in different domains to restrict the records and credentials that a MID Server can access.

Synchronize a JAR file to MID Servers
Upload a JAR file to an instance and synchronize it to all MID Servers connected to that instance. Use JAR file synchronization to create policies that only a MID Server from the same domain can use.

MID Servers used for credential-less Discovery
MID Servers that are used for credential-less Discovery require special configuration to run Network Mapper (Nmap) commands on target computers.

Install and uninstall Nmap on a MID Server
You must install Nmap on each MID Server running on a Windows host. When given the proper capability, those MID Servers can discover some basic information about CIs in your network if normal authentication fails.

**MID Server extensions**

**vCenter event collector**

The vCenter event collector listens for vCenter-related events and updates the CMDB accordingly. The event collector allows the CMDB to be updated with changes to virtual machines (VMs), in addition to the updates detected by Discovery. A change to a VM is sent as an event from the vCenter server to the vCenter event collector. When an event is received, the CMDB is updated accordingly. Full vCenter Discovery does not need to rerun. For some events, such as powered on and powered off events, Discovery does not need to run again at all. For most events, Discovery runs only on the necessary vCenter resource.

**SNMP trap collector extension**

The SNMP trap collector is a MID Server extension that listens for SNMP traps from the devices on your network. Upon receiving a trap, the MID Server sends the trap to the instance for further processing by Event Management. If Event Management is not active, traps are not processed and are discarded by the instance.

**MID Server selection**

You can configure MID Server selection by application, IP address ranges, network capability, or behavior. Specific MID Servers can be assigned to particular tasks, or the MID Server can be selected automatically. MID Servers can use domain separation to limit the scope of discoveries and event management.

---

**MID Server criteria**

MID Servers offer these types of criteria that help an application determine which MID Server to use:
• **Application:** The application that you specify on the MID Server. You can designate these applications for a specific MID Server:
  • Discovery
  • Orchestration
  • Service Mapping
  • Event Management
  • Operational Intelligence
  • Cloud Management

An ALL application option is also available. By default, this option includes all applications. You can configure which applications are included in the ALL designation.

• **IP address or range:** The IP address or the IP ranges that the MID Server is allowed to work within. You can specify an IP address or IP range in the application, such as on a Discovery schedule or an Orchestration activity, and for the MID Server. If the IP configured in the application matches the IP address or falls within the allowable IP range configured on the MID Server, a match is possible, and that MID Server passes this criteria. To have the instance automatically assign IP ranges (subnets) to available MID Servers, see Using MID Server IP range auto-assignment.

• **Capabilities:** The network capability an application needs to use, such as the PowerShell Orchestration activity or the Flow Designer PowerShell step. Some applications, like Cloud Management, require a specific capability.

  **Note:** Discovery and Service Mapping can also use behaviors, which determine the type of port probes used during the port scan phase of Discovery. Both Discovery and Service Mapping use a behavior to discover load balancers running on Linux. Other applications do not use behaviors. Behaviors are not used for auto-selection, default MID Servers, or specific MID Servers as described below. See Discovery behaviors for more information.

### How an application selects a MID Server

If you do not specify a specific MID Server for an application to use, the application tries to select one. Each application relies on different criteria to select an appropriate MID Server.

<table>
<thead>
<tr>
<th>Application</th>
<th>Supported Application on the MID Server</th>
<th>IP address range</th>
<th>Capability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery (Select Auto-Select MID Server on the Discovery schedule)</td>
<td>The <strong>Discovery</strong> or ALL application must be specified on the MID Server.</td>
<td>Discovery uses IP ranges that you configure on the Discovery Schedule form to see if they fall within the IP ranges that you configure on the MID Server, or the ALL IP ranges option must be selected on the MID Server.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Note:** Any configured behaviors are ignored.
### Using a specific MID Server

Discovery and Event Management can use a MID Server that you specifically call out.

**Note:** Selecting a specific MID Server is not the same as specifying the default MID Server for an application. A specific MID Server is always used. If it is Down or not validated, the application does not execute commands against the MID Server. A default MID Server is fallback that is used when the auto-selection of MID Servers does not find any eligible MID Server.

<table>
<thead>
<tr>
<th>Application</th>
<th>How you specify a specific MID Server</th>
<th>Criteria that the default MID Server must meet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery</td>
<td>Choose the MID Server on the Discovery schedule.</td>
<td>If you select a MID Server without the Discovery application, it automatically adds the Discovery application.</td>
</tr>
<tr>
<td>Orchestration</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Service Mapping</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Application | How you specify a specific MID Server | Criteria that the default MID Server must meet
--- | --- | ---
Event Management | Choose one or more MID Servers on the connector instance event collection, such as HPOM. | N/A
Cloud Management | N/A | N/A

**Note:** If a MID Server manages resources within defined IP ranges for Orchestration, you must map the fully-qualified domain name (FQDN) of a server with its IP address to run certain activities, such as Exchange activities.

### Domain separation

If you are using domain separation, you can configure MID Servers to be in separate domains. The domain that the MID Server is in affects how the application selects the domain:

- **Discovery and Service Mapping:** On the Discovery schedule, the MID Servers and clusters that available for selection are limited to the same domain of the user who is configuring the schedule. This also applies to the auto-selection option: only MID Servers in the same domain as the user can be automatically selected.

### MID Server selection test

If Service Mapping is active, you can preview which MID Server that Service Mapping uses for a specific target device or computer. To do this, navigate to Service Mapping > MID Servers and click MID Selection Test. Enter the IP address and an optional application and capability, and then click OK. The name of the MID Server that Service Mapping will use appears in the window.

### Configure a default MID Server for each application

You can configure a default MID Server that an application can use if all other possible MID Servers are unavailable. You can narrow down the list of applications that are included in the definition of ALL.

Role required: agent_admin or admin
Applications are only available when their respective plugins are activated.

The default MID Server is used when applications fail to find a suitable MID Server that matches configured criteria during auto-select. The default MID Server for the **ALL** application is used if the default MID Server for the specific application is not available. Some applications also offer a property to set the default MID Server.

**Important:** If you configure a MID Server for ALL IP ranges (type **Include**) and also create an IP range of type: **Exclude** for the same MID Server, the system ignores the excluded IP range for that MID Server.

The default MID Server does not need to meet any criteria (application, IP range, behavior, or capability) to be used. Specifying a default MID Server is optional, and you can use a MID Server as the default for more than one application.

<table>
<thead>
<tr>
<th>Application</th>
<th>Additional notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery</td>
<td>Discovery attempts to use the default MID Server when the Discovery schedule specifies <strong>Auto-Select MID Server</strong> and Discovery cannot find any MID Servers with the correct application and IP range.</td>
</tr>
<tr>
<td>Orchestration</td>
<td>Orchestration attempts to use the default MID Server when it cannot find any MID Servers with the capabilities that you define in the Orchestration activity. You can also specify a default MID Server. The value in that property automatically synchronizes with the default MID Server you select in the Orchestration application.</td>
</tr>
<tr>
<td>Alert aggregation and RCA</td>
<td>Not applicable. The MID Server is selected if it has the RCA capability. Route to right MID by domain.</td>
</tr>
<tr>
<td>Service Mapping</td>
<td>If there are no MID Servers with matching application, capability, or IP range, Service Mapping uses the default MID Server.</td>
</tr>
<tr>
<td>Event Management</td>
<td>You can specify a default MID Server for Event Management using the mid.server.connector.default system property. Event Management does not use the default MID Server in the application record.</td>
</tr>
</tbody>
</table>
1. Navigate to **MID Server > Applications**.
The list of installed applications that can use MID Servers appears.

2. Click the name of an installed application.

3. Select a MID Server from the list in the **Default MID Server** field.

4. To select additional MID Servers for this application, click **Edit** in the **MID Servers** related list and select alternate MID Servers that this application is allowed to use.

5. Click **Update**.

*Select applications to include in the definition of ALL for a MID Server*
You can narrow down the list of applications that are included in the definition of ALL.

Role required: agent_admin or admin

You can specify the ALL application for a MID Server, which means that the MID Server is allowed to work with any of the applications that require MID Servers, such as Discovery, Event Management, Service Mapping, and so on. But you might not want all applications to be included in the definition of ALL. For example, you might want to exclude Service Mapping from the ALL definition if you already have a dedicated MID Server to work with Service Mapping.

1. Navigate to **MID Server > Applications**.
The list of installed applications that can use MID Servers appear.

2. If you do not see the **Included in application ALL** column, you can personalize the list and add it.

3. For each application, double-click the value in the **Included in application ALL** column.
4. Change the value to **true** (to include) or **false** (to exclude).

*Configure an IP address range for the MID Server*
You can manually configure an IP address range for the MID Server to explore.

Role required: agent_admin or admin
Applications, such as Discovery and Orchestration, can specify an IP range or the specific IP address of a target. When the application looks for a MID Server to use during auto-selection, it chooses a MID Server whose IP range includes the application's range or specific IP address. Applications also use other criteria, such as the MID Server's supported application or capability. See MID Server selection for more information.

**Note:** This is a manual configuration procedure. To learn how the system can assign IP address ranges to selected MID Servers automatically, see Using MID Server IP range auto-assignment.

These applications use IP ranges as follows:

- **Orchestration:** Use the IP address of the target machine (together with the capability) to select the correct MID Server for Orchestration activities. See the procedure in this topic to configure the IP address.
- **Service Mapping:** Select the MID Server whose IP address range matches the IP in the discovery request. See MID Server configuration for Service Mapping for more information.
- **Discovery:** Can select an IP address range using the same criteria as Service Mapping. Discovery can also use a quick IP range that you specify in the Discovery schedule.

**Tip:** You can also use the ALL IP range, which allows the MID Server to be used with any range of IP addresses that an application specifies. This only allows the MID Server to access IP ranges, it does not mean that the MID Server can actually reach all of the IP ranges. To function with an application, the MID server must have access to the IP ranges that the application needs.

Valid IP address ranges can be as follows:

- An IP address in dotted decimal or hexadecimal format. The hexadecimal format can be explicitly prefixed with 0x, this is not mandatory. Here are examples:
  - 10.11.144.155
  - 0xA0B909B
  - 0xA0B909B
• An IP address range in dotted decimal or hexadecimal format. Here are examples:
  • 10.11.144.150-10.11.144.160
  • 0x0A0B9096-0xA0B90A0
  • 10.11.144.150-0xA0B90A0

• An IP network address with the net mask specified after a slash (/) in regular notation (0-32 inclusive) or in IP address notation. Here are examples:
  • 10.11.144.0/24 10.11.144.0/255.255.255.0
  • 10.11.144.0/0xFFFFFF00
  • 0xA0B9000/24
  • 0xA0B9000/0xFFFFFF00

1. Navigate to MID Server > IP Ranges.
2. Click New.
3. Complete the form, using the fields in the table.

### IP address ranges

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for this IP range. The default is Global.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of range:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Include</strong>: Include the specified IP range.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Exclude</strong>: Exclude the IP address range.</td>
</tr>
</tbody>
</table>

**Note**: If a MID Server is configured for **ALL** applications, any IP addresses configured for exclusion are ignored by the system. If your goal is to configure default MID Servers for separate applications in your system, see Configure a default MID Server for each application.

<table>
<thead>
<tr>
<th>Range</th>
<th>Enter the range in a valid format.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related list</td>
<td>MID Servers</td>
</tr>
<tr>
<td></td>
<td>The MID Servers that can use this IP address</td>
</tr>
<tr>
<td></td>
<td>range.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**Important**: IP ranges assigned manually prior to using auto-assignment in the Discovery Quick Start are affected as follows:

• Individual IP ranges are retained and appended to the ranges assigned automatically by the system for the designated MID Server.

• If the MID Server was configured with the **ALL** ranges selection, the auto-assignment feature overwrites that designation with the ranges it finds.

Open the **ALL** IP range record and configure the MID Servers that you want to use with any set of IP addresses.

**Override the MID Server selection filter**

You can use the override feature to write your own filter condition that overrides the normal MID Server selection criteria for an application. An override has precedent over the default filter and can be defined for a specific selection condition.

Before attempting to create an override filter, be sure you understand the criteria the platform uses to select MID Servers. See **MID Server selection** for details.

Role required: admin
Note: The override feature is intended for Cloud Management and Cloud Discovery only. The Override by capability filter is provided by default.

There are four MID Server selection filters included in the base ServiceNow system. These filters are applied to all MID Servers in order until the system finds a matching condition:

- Status Filter
- App Filter
- Capability Filter
- IP Filter

Important: The override feature allows multiple filter types but only one override filter for each filter type. The Override selector filter type overrides all other filters and takes complete control of the MID Server selection. If this type is active, it is the only filter applied.

1. Navigate to MID Server > Mid Selector Override. The list of MID Server overrides appears.
2. Click New to create a new filter.
3. Complete these fields:
   - Name: Unique name for this override. Ensure that you can identify the override type by the name.
   - Script: Condition for this filter. Create the MID Server selection logic for your override in this field, using the directions provided in the function template. Look at the Override by capability filter as an example before starting to create your filter.
   - Type: Type of override being configured. Select one of the four default filters to override with your condition, or select Override selector to create a filter that overrides all the others.
4. Click **Submit**.
```javascript
(function filter(/** @type{MIDServerJS | null} */ candidateMIDList, /** @type{MIDServerJS | null} */ defaultSelectedMIDList, /* @type{Native JS object | null} */ midSelectorContext, /* @type{MIDSelectorParamJS | null} */ requestedParameters) {
  // If anything matching no need to do anything
  if (defaultSelectedMIDList.length > 0) {
    return defaultSelectedMIDList;
  }

  // Check if this is cloud capability - if not nothing to do
  if (!hasCloudCapability(requestedParameters.capabilities)) {
    return defaultSelectedMIDList;
  }

  // get first non cloud capability (e.g AWS) - there should be only one more
  var capability = getNonCloudCapability(requestedParameters.capabilities);
  if (capability) {
    gs.warn("MD Selection filterOnCapability could not find a capability for provider!");
    return defaultSelectedMIDList;
  }

  // Get mid with AWS capability
  var ids = getMidsWithCapability(capability);
  if (ids.length > 0) {
    return ids;
  }

  ids = getMidsWithCapability('Cloud Management');
  getMidsWithoutCapability(ids, capability);
```
Using MID Server IP range auto-assignment

Discovery Quick Start can automatically assign ranges of IP addresses, called subnets, to qualified MID Servers. This subnet auto-assignment requires SNMP credentials for read-only access to routers Discovery uses. The Automation Status Set form shows summary details of subnet Discoveries and the IP range assignments for associated MID Servers.

To be automatically assigned to a subnet, a MID Server must be:

- In a running (Up) state.
- Successfully validated.
- Able to access one or more subnets in your network.

The subnet assignments that the instance makes for your MID Servers are stored in the Automation Status Set [automation_status_set] table. For details about MID Server auto-assignment, see Discovery Quick Start.

**Important:** You must auto-assign at least one MID Server to create a schedule automatically.

Required SNMP OIDs for MID Server IP range auto-assignment

Customers who use network service providers must request specific SNMP access to use MID Server IP range auto-assignment.

IP range auto-assignment requires SNMP credentials for read-only access to all routers that Discovery uses to identify subnets. In addition, your service provider must grant the following SNMPWALK access:

- iso.org.dod.internet.mgmt.mib-2.ip.ipRouteTable (1.3.6.1.2.1.4.21)
  - ipRouteDest (1.3.6.1.2.1.4.21.1.1)
  - ipRouteNextHop (1.3.6.1.2.1.4.21.1.7)
  - ipRouteType (1.3.6.1.2.1.4.21.1.8)
  - ipRouteMask (1.3.6.1.2.1.4.21.1.11)
- iso.org.dod.internet.mgmt.mib-2.ip.ipForward.ipCidrRouteTable (1.3.6.1.2.1.4.24.4)
  - ipCidrRouteDest (1.3.6.1.2.1.4.24.4.1.1)
View automation status sets and IP range assignments

The Automation Status Set form shows summary details of a subnet Discovery and the subsequent IP range assignments for MID Servers selected for automatic subnet assignment.

Role required: admin

1. Navigate to **MID Server > Automation Status Sets**.
2. Select a status record for a subnet Discovery you want to view.

   The form contains read-only status information about the selected Discovery, the subnets found, and the range assignment process for the MID Servers you selected for auto assignment.

   **Important:** IP ranges assigned manually prior to using auto-assignment in the Discovery Quick Start are affected as follows:
   - Individual IP ranges are retained and appended to the ranges assigned automatically by the system for the designated MID Server.
• If the MID Server was configured with the **ALL** ranges selection, the auto-assignment feature overwrites that designation with the ranges it finds.
The Automation Status Set shows the IP range assignments for the MIO Servers selected for automatic range configuration. All auto-populated MIO Server ranges from this process are subnets only.

This form includes summary details of the Discovery that identified the available subnets and their ranges.

<table>
<thead>
<tr>
<th>Number</th>
<th>STA0061003</th>
<th>Subnet discovery status</th>
<th>DISK010022</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Completed</td>
<td>Range assignment status</td>
<td>DISK010023</td>
</tr>
</tbody>
</table>

**Subnet Discovery Status**
Range Assignment Status

This tab shows information for the currently running Subnet Discovery.

<table>
<thead>
<tr>
<th>Number</th>
<th>DISK010022</th>
<th>State</th>
<th>Active</th>
</tr>
</thead>
<tbody>
<tr>
<td>Started</td>
<td>62</td>
<td>Subnet Discovery</td>
<td></td>
</tr>
<tr>
<td>Completed</td>
<td>31</td>
<td>Created</td>
<td>2017-03-24 14:24:25</td>
</tr>
<tr>
<td>Duration</td>
<td>43 Minutes</td>
<td>Updated</td>
<td>2017-03-24 15:07:41</td>
</tr>
</tbody>
</table>

**Related Links**

**MIO Servers**

<table>
<thead>
<tr>
<th>Name</th>
<th>Host name</th>
<th>Status</th>
<th>Validated</th>
<th>Version</th>
<th>Logged in user</th>
</tr>
</thead>
<tbody>
<tr>
<td>daw-143corp.org</td>
<td>Down</td>
<td>Yes</td>
<td></td>
<td>track04-04-2016_02-08-2017_1803</td>
<td>MIO_User</td>
</tr>
</tbody>
</table>

Actions on selected rows...
3. Select the **Subnets Discovered** related list to view the list of subnets available for assignment.

4. Select the **IP Range Assignments** related list to view the IP ranges that were assigned to a MID Server.

   **Caution:** IP ranges identified by Discovery are stored in the IP collection [ip_address_collection] table, which is only used for MID Server IP range auto-assignment in the Jakarta release. This table
is intended for future development and **should not** be used in any customizations, including column additions, business rules, or scripting actions.

### Map an IP address to a DNS name

Associate the IP address to a DNS name to ensure the appropriate MID Server is selected. The IP Address range configuration determines which MID Server is selected. If the MID Server manages resources within defined IP ranges, all host servers must have their DNS names mapped to an IP address.

Role required: admin
The association of an IP address to a DNS name ensures that the appropriate MID Server is selected based on the IP Address range configuration. If this is not done, Orchestration reverts to the default MID Server.

If Discovery cannot discover the server and resolve the DNS name to an IP address, you must create the mapping manually.

**Important:** The platform does not map `localhost` to 127.0.0.1 automatically. You must create that mapping using this procedure.

1. Enter `cmdb_ci_dns_name.list` in the navigation filter.
   
   A list of DNS names appears.
2. Check the list for your host server.
   
   If the server does not appear in the list, continue with this procedure.
3. Click **New**.
4. Enter the fully-qualified domain name (FQDN) of the host server in the **Name** field.
5. Right-click in the form header and select **Save** from the context menu.
6. In the **IP Address** related list, click **New**.
7. In the **IP Address** field, enter the IP address of your host server.
8. In the **Nic** field, select `eth0` or your preferred network interface controller.
9. Leave the **Netmask** field blank.
10. Click **Submit**.

**Configure MID Server capabilities**

MID Server capabilities define the specific functions of a MID Server within an IP address range, allowing an application to select the most appropriate MID Server. Configure capabilities on MID Servers for applications like Orchestration, Cloud Management, and Service Mapping.

Role required: admin or sm_admin
Several applications use capabilities, IP ranges, and MID Server selection to narrow the pool of MID Servers the applications need.

**Note:** At least one capability is required for each MID Server used by Orchestration. See MID Servers for Orchestration for more information.

The following capabilities are available by default with Discovery:

<table>
<thead>
<tr>
<th>All</th>
<th>IBM</th>
<th>Resolve DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ansible</td>
<td>JDBC</td>
<td>REST</td>
</tr>
<tr>
<td>AWS</td>
<td>NetApp</td>
<td>SNMP</td>
</tr>
<tr>
<td>Azure</td>
<td>Nmap</td>
<td>SOAP</td>
</tr>
<tr>
<td>Chef</td>
<td>OpenStack</td>
<td>SSH</td>
</tr>
<tr>
<td>Cloud Management</td>
<td>PowerShell</td>
<td>VMware</td>
</tr>
<tr>
<td>Google</td>
<td>RCA</td>
<td>WMI</td>
</tr>
</tbody>
</table>

1. Navigate to MID Server > Capabilities.
2. Select an existing capability. You can also select ALL to include all capabilities.

**Note:** Ensure that each IP address range has MID Servers with the necessary capabilities to complete the Orchestration activities on that network segment.

3. Create a new capability:
   a) Click New.
   b) Configure the value for a custom capability.
      An example is a capability for DOMAIN, with a value of service-now.
   c) Click Submit.

4. Click Edit in the MID Servers related list to add MID Servers to the capability.
5. Select one or more MID Servers for this capability from the Available list.
6. Click Save.

   The capability defined here also appears in the primary record for this MID Server.

**MID Server capabilities**

MID Server capabilities define the specific functions of a MID Server within an IP address range.

**Nmap capability**

The Nmap capability is only assigned to MID Servers for which the Network Mapper (Nmap) scanner has been installed for credential-less Discovery. This capability cannot be added to or removed from any MID Server manually. For instructions on installing or uninstalling Nmap, see Install and uninstall Nmap on a MID Server

**MID Server capability values**

Capabilities provided in the base system do not have a defined value string. A MID Server configured to use a capability that has no value can locate any device using that capability's protocol. If a capability has a defined value, the MID Server using that capability finds only those devices using that protocol that match the value string exactly. The exception to this is the Resolve DNS capability, which is configured to resolve any DNS name into an IP address using a partial string match.

Starting with the madrid release, the [capability name]:[value] combination appears in the slushbucket when you add a capability to a MID Server. This combination allows you to see all the capabilities that have different values, even if the capability name is the same. For example, if you are using the Cloud Management capability, and you use the value field to specify the us-west logical datacenter on one of the capability records, you can see the combination in the Collection list.
Scripted MID Server capability value matching

You can use value tests to create capabilities that find devices using values without requiring exact string matching. Action on these values is controlled by a user-defined script.

The Resolve DNS capability is provided in the base system and is configured to resolve DNS names into IP addresses for devices whose names end with a specified domain name. The capability Value entered is automatically prefaced with a dot during processing to match domain syntax. This value can contain one or more sub-domains, but must include the end of the domain string. Matching devices must end with the identical syntax. The script for the Resolve DNS capability determines if a device name matches the criteria defined by Value. If a match exists, the platform performs the address resolution automatically. For example, if the value for the Resolve DNS capability is service-now.com, the MID Server with this capability finds lnxlab01.sandiego.service-now.com and dbsrv101.sanjose.service-now.com. If the value is changed to sandiego.service-now.com, then the MID Server finds only lnxlab01.

Note: If Value in the Resolve DNS capability is blank, then all domains match.
To view the script for evaluating this capability, navigate to **MID Server > Capability Value Tests** and select **Resolve DNS** from the list.

### Configure a MID Server cluster

Group multiple MID Servers to form clusters, then configure clusters for fail-over protection or load balancing. Load-balancing clusters automatically balance work between each MID Server to improve
stability and performance. Fail-over clusters have a configured order used to determine which MID Server to use next if a failure occurs.

Ensure that each MID Server in the cluster has the appropriate capabilities for the job. A MID Server in a fail-over cluster must have the same capabilities (or expanded capabilities) as the MID Server it is expected to replace.

Role required: admin

---

You can select a MID Server cluster from the Discovery Schedule form.

1. Navigate to **MID Server > Clusters**.
2. Click **New**.
3. Name the cluster and select the cluster type: **Failover** or **Load Balance**.
4. Right click in the header bar and select **Save** from the context menu.
5. Click **Edit** in the **Includes MID Servers** Related List.
6. Select appropriate MID Servers for this cluster from the slushbucket.

**MID Server clusters**

MID Server clusters enable multiple MID Servers with the appropriate capabilities to be grouped together for load balancing and fail-over protection.

**External data sources**

For performance and reliability reasons, these data sources should not be used with MID Server clusters. These external data sources should only be used with dedicated MID Servers.

- LDAP
- Export sets
- JDBC data sources

**Note:** If a MID Server in a cluster fails, the fail-over MID Server starts over at the beginning of the ECC queue task even if much of the information from the JDBC data source was already returned.
This can result in duplicate data. For more details, see the Using MID Server clusters for JDBC data sources can cause duplicate and out-of-date data [KB0727739] article in the HI Knowledge Base.

How clusters work

MID Servers in clusters must be able to connect to the instance and to all the devices with which they are expected to communicate. If all MID Servers in a cluster are down, the discovery is canceled. Make sure all the MID Servers are added to any Access Control List (ACL) in use. MID Server clusters are managed by a business rule called MID Server Cluster Management, which checks to see if the MID Server assigned to a job in the ECC Queue belongs to a cluster.

Load balancing

If the cluster business rule determines that a MID Server is part of a load balancing cluster, the application using the MID Server automatically balances the work between the MID Servers in that cluster. It is good practice to put MID Servers with the same capabilities in a load balancing cluster.

Fail-over protection

MID Servers in a fail-over cluster each have a configured order that the platform uses to determine which MID Server to use next in case of failure. MID Servers in a fail-over cluster work independently and do not load balance with other MID Servers in that cluster (although they might also be members of load balancing clusters). When a MID Server fails, the MID Server Cluster Management business rule selects the highest available MID Server in the order to take over the work. The selected MID Server checks the ECC Queue and starts with jobs that are either Processing or Ready.

Note: MID Server clustering does not support the ECC queue topics Command or SystemCommand. If these commands are received, the clustered MID Servers do not redirect the ECC queue to another MID Server. The ECC queue records stay on the ECC queue without being processed.

Configure a fail-over MID Server with at least the same capabilities as the MID Server it is intended to relieve.

Note: If a MID Server fails while the Shazzam probe is running and auto-selection is configured, failover is not available. The Shazzam discovery stops. Discovery does not automatically choose another MID Server.

MID Server cluster event

The following event is triggered when the platform cannot find a MID Server with the appropriate capabilities to replace a MID Server in a fail-over cluster. Use this event to create an email to notify appropriate users that the cluster has failed.

MID Server cluster event

<table>
<thead>
<tr>
<th>Event</th>
<th>Table</th>
<th>Description</th>
<th>Business Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>mid_server.cluster.down</td>
<td>MID Server Cluster [ecc_agent_cluster] failed</td>
<td>A MID Server cluster has failed</td>
<td>MID Server Cluster Management</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Combining clusters

A MID Server can be added to both types of clusters at the same time. This diagram shows a scenario in which a MID Server from a load balancing cluster (MID Server D) is also present in a fail-over cluster. If MID Server D fails, MID Server E in the failover cluster is available to the load balancing cluster to perform the tasks previously assigned to MID Server D.

Specifying a specific MID Server cluster

You can specify a specific MID Server cluster for a Discovery schedule. The discovery process uses that cluster only. You cannot chain clusters or specify a single MID Server that belongs to multiple clusters.

Distributed MID Server clusters for Operational Intelligence

The distributed MID Server cluster type is used exclusively in Operational Intelligence, which analyzes Event Management events and generates anomaly alerts. These MID Servers communicate with one another to distribute and balance the workload. For details, see MID Server distributed clusters for Operational Intelligence

Set MID Server thread use

The three parameters: threads.interactive.max, threads.expedited.max, and threads.max define the maximum numbers of worker threads that can run simultaneously in each pool. Change the number of threads used by the MID Server according to performance requirements. MID Servers which compete with other programs for CPU time can use fewer threads than the default. MID Servers which need more speed, and have a host computer powerful enough, can use more threads.

Role required: admin
Changing the thread parameters can affect the MID Server performance. The interactive thread pool is designed for executing interactive messages including system commands and heartbeats. They are typically lightweight, so usually there is no need to change the default value. The expedited thread pool is designed for executing messages that have higher priority than the standard ones but less than interactive ones. Unless you have applications that produce a lot of expedited messages, there is no need to change the default value for threads.expedited.max. The standard thread pool is the busiest pool. Most probes are using it and they can take a lot of system resources such as CPU, memory, and so on. You can set the MID Server to use as few as five threads without issues. If the MID Server needs more speed, and the host is powerful enough or lightly loaded with other programs, raise the thread setting. The thread limit depends on the hardware and the operating system of the host. You might have to experiment to find the optimal value for your situation. The following general observations may be useful:

- Most MID Server tasks require file handles to do their job.
  - Windows: On the Windows operating system, file handles are available in a fixed quantity. If you configure too many MID Server threads on a Windows host, the MID Server can consume all the file handles before approaching maximum CPU usage. This situation appears as an Out of file handles error in the MID Server log and indicates that the MID Server is trying to use too many threads.
  - UNIX and Linux: UNIX and Linux hosts have a much different scheme for allocating file handles. Generally, you can increase MID Server thread use on these operating systems until the CPU of the host is overloaded. See your OS documentation for monitoring CPU usage.

- Each thread on the MID Server requires some memory. Exactly how much memory varies considerably from task to task and depends on the equipment being discovered. To increase the number of threads, you might have to increase the amount of memory that Java uses. If you configure insufficient memory, an Out of memory error appears in the MID Server log.

- You can set threads.max as high as 200, however, this setting may need to be changed depending on the OS. For example, Windows-based MID Servers running Discovery uses Powershell which is resource intensive. In this case, you may exhaust the CPU power of the host machine with just 50 threads count.

Follow the steps below to change the config.XML file. Alternatively, use the threads.max connection parameter. See MID Server Connection parameters for more details.

1. Open the \agent\config.xml file using any text editor.
2. Locate the following lines:

```
<!-- MID Server Threads -->
<parameter name="threads.max" value="25"/>
```

3. Edit the value. Keep in mind the cautions described above.
4. Save the record.
5. Restart the MID Server service.

Install and uninstall Nmap on a MID Server

If you decide to use credential-less Discovery in your network, you must install Nmap on each Windows MID Server that you want to use for this purpose. Self-hosted customers whose network security does not permit downloads from install.service-now.com must use a specific manual process to install and configure Nmap.

Role required: mid_admin

- Assign MID Server IP ranges to all deployed MID Servers. The quickest and most reliable way to do this is with the Using MID Server IP range auto-assignment feature available in the Discovery Quick Start wizard. This method ensures that the set of MID Servers configured to access an IP address range is comprehensive.
- Identify the IP ranges you want to explore with credential-less Discovery. Ensure that these ranges can only be accessed by MID Servers with Nmap installed, running on supported Windows hosts.
- Use the All option for selecting IP ranges and observe these requirements:
  - Restrict the use of this feature to Windows MID Servers only.
  - Ensure that Nmap is installed on each of these MID Servers.
  - Ensure that the MID Servers can access the entire customer network.
• When you create a Discovery schedule with Nmap enabled, observe these requirements for the MID Server selection options:

  • **Specific MID Cluster**: Verify that Nmap is installed on all MID Servers in the cluster, where each MID Server in the cluster is configured to access the same set of IP ranges.
  
  • **Auto-Select Mid Server**: When running horizontal Discovery, verify that Nmap is installed on at least one of the MID Servers that can access the Discovery schedule’s configured MID Server IP ranges.
  
  • **Specific MID Server**: Verify that Nmap is installed on each MID Server that can access the schedule’s configured MID Server IP Ranges.

**Note**: To use credential-less Discovery for Service Mapping, install Nmap on all MID Servers that can access the Discovery schedule’s configured MID Server IP ranges.

Role required: agent_admin

The Discovery - IP Based [com.snc.discovery.ip_based] plugin provides connection to the installer for Nmap and the programming elements that allow a Windows MID Server to run approved scripts on target CIs for credential-less Discovery. MID Servers on which Nmap is installed can execute an Nmap command configured to perform reverse DNS name resolution, discover MAC addresses, or gather OS information on target CIs without using credentials. The Discovery - IP Based plugin is activated automatically when the Discovery [com.snc.discovery] or Event Management and Service Mapping Core [com.snc.service-watch] plugins are activated.

**Service Mapping and Nmap**

Service Mapping does not check for the presence of the Nmap capability and selects the MID Server based on the IP address only. To ensure that Service Mapping does not select a MID Server without the Nmap capability, install Nmap on all MID Servers assigned to the IP address ranges for which you want credential-less Discovery to be available. If Service Mapping selects a MID Server for credential-less Discovery that does not have Nmap capabilities, this error message appears in the map at the site of the CI being discovered: 

```
Nmap is not installed on MID Server. Verify all MIDs configured to handle selected IP Address have Nmap Capability. Nmap root directory path does not exist: <path>
```

**Amazon Web Service AWS**

Running Nmap scans to or from any resource within the Amazon Web Service AWS environment is tightly regulated and requires the permission of AWS through the AWS Vulnerability/Penetration Testing Request form. AWS only permits testing of EC2 and RDS instances that you own. Tests against any other AWS services or AWS-owned resources are prohibited. In addition, any Nmap scan of a permitted instance must be performed within an approved time window. For these reasons, credential-less Discovery within an AWS environment is not appropriate, and if a violation of their policy occurs, could result in expulsion from the service.

**Supported operating systems**

Nmap is supported on all editions of these operating systems, including virtual machines and 64 bit systems:

  • Windows 2008
  • Windows 2012
  • Windows 2016

**MID Server requirements**

Nmap can be installed on MID Servers that meet these requirements:

  • Status is Up.
- MID Server is validated.
- MID Server does not already have the **Nmap** capability.

**Warning:** The MID Server installation path must not contain the following characters:
- ()
- {} 
- []

The Nmap installer replaces these characters with spaces. This prevents the installer from finding the correct path, and the installation fails. An example of a path that will fail is `C:\MIDServers\MID(1)\agent`.

1. Navigate to **MID Server > Servers**.
2. Open the desired MID Server record.
3. Under **Related Links**, select **Enable Credential-less Discovery**.
   A confirmation dialog box appears.

4. Click **Yes** to continue with the installation.
   The instance runs the Nmap installer from [https://install.service-now.com](https://install.service-now.com), a site within a ServiceNow datacenter that contains installers for the platform. This progress notice appears during installation:

   ![Enable Credential-less Discovery](image)

   **Installing Nmap...**
   
   Nmap installation is running in the background and you can close the window and it will continue installing

   ![Enable Credential-less Discovery](image)

   The **Logs** tab in the MID Server record shows the message: 
   Running system command: installNmap.
5. Click **OK** if you want to hide the dialog box while the installer continues to run in the background. Installing Nmap also installs Npcap on the host, if it is not already installed. Npcap is Nmap's packet capture library for Windows that allows Nmap to perform port scans quickly and to identify the family of the operating system running on the target. Npcap is installed once on the host and can be used by any other application that requires it, such as Wireshark.

   **Note:** If a more recent version of Npcap is already installed on the Windows MID Server host, Nmap is installed without Npcap. If an older version of Npcap is installed on the host, the Nmap installer upgrades it to the newer version.

The installation process has either of these outcomes:

- **Success:** These conditions indicate a successful installation:
  - The version of Nmap that is installed appears in the **Nmap version** field in the MID Server record.
  - The **Related Link** changes to **Disable Credential-less Discovery**.
  - The **Nmap** capability is assigned to the MID Server and appears in the **Capabilities** tab of the MID Server record.

- **Failure:** If the installation fails, an error message is logged to the **MID Server Issue [ecc_agent_issue]** table. If you run the installer again with success, the issue is marked as **Resolved**.

6. To uninstall Nmap for a selected MID Server, select **Disable Credential-less Discovery** under **Related Links** in the MID Server record.

   This dialog appears during the uninstallation process:

   ![Uninstall Nmap dialog](image)

   The **Logs** tab in the MID Server record shows the message:

   ```
   Running system command: uninstallNmap.
   ```

   **Important:** Because Npcap can be used by other applications, uninstalling Nmap does not automatically uninstall Npcap. You must uninstall Npcap manually, after determining that no other dependencies exist.

### Install Nmap on a self-hosted system

Use this procedure to install Nmap on MID Server host machines in a self-hosted environment that does not allow network access to the ServiceNow® install.service-now.com download site.

**Role required:** admin, maint

You must install Nmap manually on each MID Server host, and then configure the instance to execute credential-less Discovery.
1. Navigate to **MID Server > Properties** (MID Server Property [ecc_agent_property] table) and open the record for the **mid.nmap.version** property. This property contains the version of Nmap that you must install. Record the version number.

2. Download the correct installer executable from one of these URLs:
   - https://nmap.org/dist/: If the Nmap version in the property is 7.50, the executable you need is https://nmap.org/dist/nmap-7.50-setup.exe.

3. Create a folder called **nmap** in the MID Server **agent** folder of every MID Server you want to use for credential-less Discovery.

4. Copy the Nmap installer file that you downloaded to the **nmap** folder and rename it to **nmapInstaller.exe**.
5. Run the `agent\scripts\PowerShell\NmapInstallation.ps1` script and pass it the following parameters in the order in which they appear. This script runs the `nmapInstaller.exe` file.

   a. `$operation`: Task that `NmapInstallations.ps1` will process. To install Nmap, the task is `install`.
   
   b. `$nmap_root_path`: Complete path for the `nmap` folder that you create in step 4.
   
   c. `$nmap_self_installer`: Complete path for `nmapInstaller.exe` file that you copied in step 5.
   
   d. `$nmap_command`: Complete path for the Nmap install command. The `NmapInstallations.ps1` script installs Nmap in the `nmap` folder created in step 4. This parameter is `$nmap_root_path\nmap.exe`.
   
   e. `$nmap_uninstall_command`: Complete path for the Nmap uninstall command. This command is `$nmap_root_path\Uninstall.exe`.
   
   f. `$nmap_npcap_version`: The Npcap version installed with Nmap. This value must be the same as the value of the `mid.nmap.npcap.version` property in the MID Server Property [ecc_agent_property] table.
   
   g. `$nmap_safe_scripts`: List of safe scripts that Nmap uses. You can retrieve this list from the `mid.nmap.safe.scripts` property in the MID Server Property [ecc_agent_property] table.

6. Set up the parameters in the `NmapInstallation.ps1` script in this order:

   `./NmapInstallations.ps1 $operation $nmap_root_path $nmap_self_installer $nmap_command $nmap_uninstall_command $nmap_npcap_version $nmap_safe_scripts`

   For example, the script might look like this:

   ```
   PS C:\MidServers\mid1\agent\scripts\PowerShell> .\NmapInstallation.ps1
   "install"
   "C:\MidServers\mid1\agent\nmap" "C:\MidServers\mid1\agent\nmap
   \nmapInstaller.exe"
   "C:\MidServers\mid1\agent\nmap\nmap.exe"
   "C:\MidServers\mid1\agent\nmap\Uninstall.exe" "0.91"
   "allseeingeye-info.nse,amqp-info.nse,db2-das-info.nse,drda-
   info.nse,freelancer-info.nse,
   ike-version.nse,mcafee-epo-agent.nse,mqtt-subscribe.nse,openlookup-
   info.nse,oracle-tns-version.nse,
   quake1-info.nse,quake3-info.nse,rfc868-time.nse,rpcinfo.nse,snmp-
   info.nse,ventrilo-info.nse,
   weblogic-t3-info.nse,xmpp-info.nse"
   ```
7. After installation is complete, add the **Nmap** capability to each MID Server you want to use for credential-less Discovery.

**Attention:** Only a **maint** user can add the **Nmap** capability to a MID Server. Contact ServiceNow Technical Support to request temporary **maint** access to your instance.

a) On the instance, open the MID Server record.
b) Select the **Capabilities** related list.
c) Click **Edit**.
d) Select **Nmap** from the list of available capabilities and click **Save**.

---

**Uninstall Nmap on a self-hosted system**

Use this procedure to uninstall Nmap in a self-hosted environment that does not allow network access to the ServiceNow install.service-now.com download site.

**Role required:** admin, **maint**

Nmap must be manually uninstalled from each MID Server host machine and then disabled on the ServiceNow instance.

1. Run `Uninstall.exe` in the `nmap` folder on each MID Server host configured for credential-less Discovery.
2. After uninstallation is complete, delete the `nmap` folder from the `agent` folder.
3. Remove the **Nmap** capability from each MID Server record.

**Attention:** Only a **maint** user can remove the **Nmap** capability from a MID Server. Contact ServiceNow Technical Support to request temporary **maint** access to your instance.

a) On the instance, open the MID Server record.
b) Select the **Capabilities** related list.
c) Click **Edit**.
d) Remove **Nmap** from the active capabilities list and click **Save**.
Configure MID Server as WinRM trusted host

In environments using Windows Remote Management (WinRM), Discovery or Service Mapping can discover servers using the WinRM protocol. Add servers, which are part of WinRM, as trusted hosts on all MID Servers that Discovery or Service Mapping use for discovery.

Role required: mid_admin

MID Server cannot access servers using the WinRM protocol unless these servers are configured as trusted hosts for this MID Server.

Perform this procedure on each MID Server used by Service Mapping or Discovery.

1. On the MID Server, open the command-line shell.
2. To add all servers to the TrustedHosts lists, run the following command:
   ```bash
   winrm s winrm/config/client @{TrustedHosts="*"}
   ```
3. To add specific servers to the TrustedHosts list, run the command with the comma-separated hosts instead of the asterisk (*), for example:
   ```bash
   winrm s winrm/config/client @{TrustedHosts="serverA,serverB,serverC"}
   ```

MID Server domain separation

Use the MID Server user role to configure MID Servers to access separate domains. The credentials in the config.xml file of a MID Server determine which domains it can access. Specific MID Server policy records can be restricted for use only by MID Server from the same domain.
The records that can be read, updated, or created by a MID Server are determined by the credentials configured for that MID Server in the config.xml file. These are the user credentials that a MID Server uses to access the instance and specify which domain's records that MID Server can access.

You can create versions of these specific MID Server policy records that only a MID Server from the same domain can use. This process separation is supported for records in tables that extend MID Server Synchronized Files [ecc_agent_sync_file]:

- MID Server MIB File [ecc_agent_mib]
- MID Server JAR File [ecc_agent_jar]
- MID Server Script File [ecc_agent_script_files]

*i Note: *Attachments on MIB or JAR file records might not appear as they did in a non-domain separated environment. The attachments do not appear because the Attachments [sys_attachment] table is data separated. When data is separated between domains, a record in a child domain cannot access records in a parent domain.

### Set up domain separation for MID servers

Set up domain separation through the MID server user role and the MID Server configuration file.

Role required: admin, agent_admin

1. Configure a MID Server user within a specified domain with the proper mid_server role.
2. Specify this user within the MID Server config.xml file. When you set the MID Server user credentials in the config.xml file, make sure they are in the proper domain.

If you must change the MID Server domain:

1. Stop the MID Server and delete the ecc_agent record.
2. Update the MID Server config.xml with the new user in the new domain and restart the MID Server service.

If you need to create versions of specific MID Server files that only MID Servers in your domain can use:

1. Open or create a record in one of these MID Server modules:
2. Update an existing domain policy or submit a new record.

   **Note:** Attachments on MIB or JAR file records might not appear as they did in a non-domain separated environment. The attachments do not appear because the Attachments [sys_attachment] table is data separated. When data is separated between domains, a record in a child domain cannot access records in a parent domain.

**Configure a multi-domain MID Server**

You can create a MID Server in the global domain that can explore targets in other domains.

Before configuring a multi-domain MID Server:

- Ensure that your instance is domain separated.

Role required: admin

1. Type `sys_properties.list` in the navigation filter and press **Enter**.
2. Locate the `glide.ecc.enable_multidomain_mid` property.
3. Set the value of the property to **true**.

   **Note:** Enabling this property has no effect on existing MID Servers. MID Servers in a domain prior to setting this property, remain in that domain.

4. Create a MID Server in the global domain.

   A MID Server created in the global domain after this property is set to **true** can explore any domain for which it has the credentials. However, this MID Server is restricted to trying only the credentials for the target domains requested by ECC Queue inputs.

   **Caution:** If you reset the `glide.ecc.enable_multidomain_mid` property to **false** after creating a multi-domain MID Server in the global domain, that MID Server writes all the data it receives to the global domain and not to the correct domains.

**Synchronize a JAR file to MID Servers**

You can upload a JAR file to an instance and synchronize it to all MID Servers, or write custom probes that use the synchronized JAR file.

Role required: admin, agent_admin
Ensure that the MID Server can connect to elements inside and outside your network
Download and install the MID Server on a Linux or Windows host
Configure your MID Server
Configure MID Server security

The MID Server JAR File [ecc_agent_jar] table is domain separated. You can create versions of these policies that only a MID Server from the same domain can use. For instructions, see Set up domain separation for MID servers.

**Caution:** Synchronizing a JAR file with this procedure causes all MID Servers connected to the instance to restart automatically.

1. Navigate to **MID Server > JAR Files**.
2. Click **New**.
3. Complete the following fields:
   - **Name**: A unique and descriptive name for identifying the file in the instance.
   - **Version**: A version number for the file, if one is available.
   - **Source**: Location of the JAR file for reference purposes. Source information is not used by the system.
   - **Description**: Short description of the JAR file and its purpose in the instance.
4. Click the paper clip icon in the banner.
5. In the Attachments dialog box, click **Browse** and select the file you want to attach.

   The platform attaches the JAR file to the record and restarts the MID Servers to synchronize the file. It is not necessary to update the record to attach the file.

**vCenter event collector**

The vCenter event collector is a MID Server extension that listens for vCenter-related events and updates the CMDB accordingly.

The event collector allows the CMDB to be updated with changes to virtual machines (VMs), in addition to the updates detected by Discovery. A change to a VM is sent as an event from the vCenter server to the vCenter event collector. When an event is received, the CMDB is updated accordingly. Full vCenter Discovery does not need to rerun. For some events, such as powered on and powered off events, Discovery does not need to run again at all. For most events, Discovery runs only on the necessary vCenter resource.

For example, if a VM is turned off, the vCenter server sends the event `VmPoweredOffEvent`. The vCenter event collector receives and processes the event and the CMDB is updated to reflect that the state of the corresponding VM is set to **off**.

**Important:** With this extension, Discovery can only modify the state of a VM which exists in the CMDB. When an event with "CreatedEvent" occurs in its name, such as `VmCreatedEvent`, Discovery scans that VM and then creates the CI using the data it collects. When a new event occurs involving that CI, Discovery can update the existing record without launching another scan.

**Note:**

vCenter event collector supports domain separation by inheriting the domain of the specified Mid Server in the event collector context. However, it does not support multi-domain Mid Server configuration.

See [Discovery for VMware vCenter](https://www.servicenow.com) for supported versions of vCenter.

**How vCenter events are processed**

The MID Server listens for the vCenter events configured in the vCenter Event Collector form. When one of these events is returned from vCenter, the instance parses the payload with a business rule that converts the vCenter event into a system event (sysevent). The instance then uses that sysevent to perform tasks, such as email notification.

**Note:** If the MID server is paused when a vCenter event occurs, the MID server still processes the event. In this case, it is possible for the event collector to display a status of **Started**.

The resulting sysevents contain these values:

- **Name**: Name of the system event created from the vCenter event. This value is always `automation.vcenter`.
- **Parm1**: vCenter event that was returned. This event must be associated with an event collector record.
- **Parm2**: Event data provided by vCenter, in JSON format.
Log entries for vCenter events

Supported vCenter events

The following events are the only vCenter events handled by the base system when Discovery is activated. If you have upgraded your instance from an earlier version, you might not have the default events added with later releases. To use the missing events, manually add them.

vCenter events

<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th>Launches probe</th>
</tr>
</thead>
<tbody>
<tr>
<td>VmPoweredOnEvent</td>
<td>The VM has been powered on from the powered off state or resumed from the suspended state. This event is sent when the VM is powered on. It does not account for the time it may take to boot the host operating system.</td>
<td>None</td>
</tr>
<tr>
<td>Event name</td>
<td>Description</td>
<td>Launches probe</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>DrsVmPoweredOnEvent</td>
<td>The VM has been powered on by a distributed resource schedule (DRS), which balances workload between available resources.</td>
<td>None</td>
</tr>
<tr>
<td>VmRestartedOnAlternateHostEvent</td>
<td>The VM was restarted on another host because the original host failed.</td>
<td>None</td>
</tr>
<tr>
<td>VmPoweredOffEvent</td>
<td>The VM has been powered off. If the host OS is shut down, this event is sent after the host OS shuts down and the VM enters the powered off state.</td>
<td>None</td>
</tr>
<tr>
<td>VmPowerOffOnIsolationEvent</td>
<td>The VM has been powered off on an isolated host in an HA cluster.</td>
<td>None</td>
</tr>
<tr>
<td>VmShutdownOnIsolationEvent</td>
<td>The VM has been shut down on an isolated host in an HA cluster.</td>
<td>None</td>
</tr>
<tr>
<td>VmSuspendedEvent</td>
<td>The VM is suspended. This event is sent after the VM suspension is complete.</td>
<td>None</td>
</tr>
<tr>
<td>VmRelocatedEvent</td>
<td>The VM has been relocated while offline (either suspended or powered off). A VM migration of the VM to a different host, or the migration of any storage used by the VM triggers the event.</td>
<td>None</td>
</tr>
</tbody>
</table>
| VmMigratedEvent            | One or both of the following occurs:  
  • The VM has been hot-migrated, with vMotion, to another ESX server.  
  • The storage for the VM has been hot migrated.                                                                                                                                                      | None           |
<p>| DrsVmMigratedEvent         | Migration of a VM recommended by a DRS.                                                                                                                                                                       | None           |
| VmRemovedEvent             | The VM instance has been deleted from vCenter.                                                                                                                                                                | None           |
| VmClonedEvent              | The VM was cloned successfully.                                                                                                                                                                               | VMware - vCenter VMs |
| VmCreatedEvent             | The VM was successfully created.                                                                                                                                                                             | VMware - vCenter VMs |
| VmDeployedEvent            | The VM was deployed successfully.                                                                                                                                                                            | VMware - vCenter VMs |
| VmDiscoveredEvent          | The vCenter successfully discovers the VM.                                                                                                                                                                   | VMware - vCenter VMs |
| VmRegisteredEvent          | The VM was successfully registered.                                                                                                                                                                           | VMware - vCenter VMs |
| VmReconfiguredEvent        | The VM was reconfigured.                                                                                                                                                                                      | VMware - vCenter VMs |</p>
<table>
<thead>
<tr>
<th>Event name</th>
<th>Description</th>
<th>Launches probe</th>
</tr>
</thead>
<tbody>
<tr>
<td>VmInstanceUuidAssignedEvent</td>
<td>A new instance UUID was assigned to the VM.</td>
<td>None</td>
</tr>
<tr>
<td>VmRenamedEvent</td>
<td>The VM was successfully renamed.</td>
<td>None</td>
</tr>
<tr>
<td>VmUuidAssignedEvent</td>
<td>A new BIOS UUID was assigned to the VM.</td>
<td>None</td>
</tr>
<tr>
<td>VmMacAssignedEvent</td>
<td>A new MAC address was assigned to the VM.</td>
<td>VMWare - vCenter VM NICs</td>
</tr>
<tr>
<td>VmMacChangedEvent</td>
<td>The MAC address of a VM was changed.</td>
<td>VMWare - vCenter VM NICs</td>
</tr>
<tr>
<td>VmGuestShutdownEvent*</td>
<td>The guest VM shut-down.</td>
<td>None</td>
</tr>
<tr>
<td>VmStoppingEvent</td>
<td>The VM stopped.</td>
<td>None</td>
</tr>
<tr>
<td>VmResettingEvent</td>
<td>The VM reset.</td>
<td>None</td>
</tr>
<tr>
<td><strong>Cluster events</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ClusterCreatedEvent</td>
<td>A cluster was created.</td>
<td>VMWare - vCenter Clusters</td>
</tr>
<tr>
<td>ClusterReconfiguredEvent</td>
<td>A cluster was reconfigured.</td>
<td>VMWare - vCenter Clusters</td>
</tr>
<tr>
<td>ClusterDestroyedEvent</td>
<td>A cluster was destroyed.</td>
<td>None</td>
</tr>
<tr>
<td><strong>Datastore events</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DatastoreRenamedEvent</td>
<td>A datastore was renamed.</td>
<td>None</td>
</tr>
<tr>
<td>VMFSDatastoreCreatedEvent</td>
<td>A VM File System (VMFS) datastore was created.</td>
<td>VMWare - vCenter Datastores</td>
</tr>
<tr>
<td>DatastoreDiscoveredEvent</td>
<td>A host was added to VirtualCenter and datastores were discovered.</td>
<td>VMWare - vCenter Datastores</td>
</tr>
<tr>
<td>NASDatastoreCreatedEvent</td>
<td>An Network Attached Storage (NAS) datastore was created.</td>
<td>VMWare - vCenter Datastores</td>
</tr>
<tr>
<td>LocalDatastoreCreatedEvent</td>
<td>A local datastore was created.</td>
<td>VMWare - vCenter Datastores</td>
</tr>
<tr>
<td>VMFSDatastoreExpandedEvent</td>
<td>A datastore was expanded.</td>
<td>VMWare - vCenter Datastores</td>
</tr>
<tr>
<td>DatastoreDestroyedEvent</td>
<td>A datastore was removed from VirtualCenter.</td>
<td>None</td>
</tr>
<tr>
<td><strong>Network events</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVPortgroupCreatedEvent</td>
<td>A port group was created.</td>
<td>VMWare - vCenter Networks</td>
</tr>
<tr>
<td>DVPortgroupRenamedEvent</td>
<td>A port group was renamed.</td>
<td>None</td>
</tr>
<tr>
<td>DVPortgroupDestroyedEvent</td>
<td>A port group was destroyed.</td>
<td>None</td>
</tr>
<tr>
<td><strong>Resourcepool events</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ResourcePoolDestroyedEvent</td>
<td>A resource pool was destroyed.</td>
<td>None</td>
</tr>
<tr>
<td>ResourcePoolCreatedEvent</td>
<td>A resource pool was created.</td>
<td>VMWare - vCenter Clusters</td>
</tr>
<tr>
<td>ResourcePoolMovedEvent</td>
<td>A resource pool was moved.</td>
<td>VMWare - vCenter Clusters</td>
</tr>
<tr>
<td>ResourcePoolReconfiguredEvent</td>
<td>A resource pool was reconfigured.</td>
<td>VMWare - vCenter Clusters</td>
</tr>
</tbody>
</table>
### Event name | Description | Launches probe
---|---|---
**DVS events**
DvsCreatedEvent | A distributed virtual switch was created. | VMWare - vCenter Networks
DvsRenamedEvent | A distributed virtual switch was renamed. | None
DvsDestroyedEvent | A distributed virtual switch was destroyed. | None

**Datacenter events**
DatacenterCreatedEvent | A datacenter was created. | VMWare - vCenter Datacenters
DatacenterRenamedEvent | A datacenter was renamed. | None

---

**Configure and run the vCenter event collector extension**

Configure the vCenter event collector extension in the MID Server module, and then add or remove supported events.

Before configuring event collectors, perform these tasks:

- Deploy and start a MID Server.
- Ensure that the MID Server has access to the vCenter.
- Run discovery on the vCenter.

Role required: agent_admin, admin

Multiple MID Servers can listen to the same vCenter instance, and you can add multiple Event Collectors for different vCenters to a single MID Server. Make sure you configure the events on the event collector record that specify the correct MID Server.

**Note:** You can add events to the vCenter event collector. However, not every event is supported by the base system event handlers. If you want to handle events other than those supported in the base Discovery system, you must create a script action to process the events. For instructions, see #unique_1778. As a reference, the instance processes the vCenter events in the base system with a script action called **Discovery: Process vCenter events**. Do not edit or delete this script action.

To configure the vCenter event processor extension:

1. Navigate to **MID Server > Extensions > vCenter Event Collectors**.
2. Click **New** or open an existing extension.
3. Fill in the fields, as appropriate from the table.
4. Right-click in the header bar and click **Save** in the context menu.
   - The **vCenter Event** related list appears, containing the default events that the system is configured to handle.
5. To select a different vCenter event, click **Edit** in the **vCenter Event** related list and browse for the event.
   - The slushbucket does not display all the available events in the opening list. Use the filter to browse for events not displayed.
6. Under **Related Links** click **Start** to save the events in this collection and start the collector. The Related Links in this form work as follows:

**Commands available in the vCenter event processor extension**

<table>
<thead>
<tr>
<th>Related Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Starts the collector if it is not running. The extension connects to the specified vCenter server by enumerating the VMware credentials in the credential set until a connection can be made. Next, the extension tells the vCenter server to supply the events specified in the Collector Context.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the running collector on the configured MID Server. No action is taken if the extension is not running.</td>
</tr>
<tr>
<td>Restart</td>
<td>Stops, then starts the collector on the configured MID Server.</td>
</tr>
<tr>
<td>Test</td>
<td>Tests the parameters for validity. If the IP address, hostname, and the set of events is valid then the test returns a successful status. If any of the parameters are incorrect, an error is shown. Running a test does not affect any extensions that are currently running.</td>
</tr>
<tr>
<td>Related Link</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update parameters</td>
<td>Sends updated parameters to the collector. Any changes you make to the collector while the MID Server is running do not take effect immediately when they are saved. If you click this control when the collector is not running, no update is made. In the case of the vCenter extension, the collector first tests the parameters for validity. If the parameters are valid, the extension disconnects from the vCenter server and reconnects with the new parameters.</td>
</tr>
</tbody>
</table>
## vCenter Event Collector Context

### vCenter ITOM

- **Name**: vCenter ITOM
- **Short description**
- **Extension**: vCenterExtension
- **Status**
- **Execute on**:
  - Specific MID Server: [value]
  - MID Server: [value]
  - vCenter: [value]
  - Executing on:

**Related Links**
- Start
- Stop
- Restart
- Test
- Update parameters

### vCenter Extension Context = vCenter ITOM

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMPoweredOnEvent</td>
<td>VM powered on</td>
</tr>
<tr>
<td>VMRemovedEvent</td>
<td>VM removed</td>
</tr>
<tr>
<td>VMClosedEvent</td>
<td>VM closed</td>
</tr>
<tr>
<td>VMRenamedEvent</td>
<td>VM renamed</td>
</tr>
<tr>
<td>VMRelocatedEvent</td>
<td>VM relocated</td>
</tr>
<tr>
<td>VMPoweredOffEvent</td>
<td>VM powered off</td>
</tr>
<tr>
<td>VMCreatedEvent</td>
<td>VM created</td>
</tr>
<tr>
<td>VMDeployedEvent</td>
<td>VM deployed</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### SNMP trap collector extension

The SNMP trap collector is a MID Server extension that listens for SNMP traps from the devices on your network.

Upon receiving a trap, the MID Server sends the trap to the instance for further processing by Event Management. If Event Management is not active, traps are not processed and are discarded by the instance.
For the SNMP trap collector extension to receive traps from network devices, each device must designate the MID Server that runs the SNMP trap collector extension as a recipient of the trap. See the documentation for the network device to configure your hardware to do this. Generally, the SNMP trap collector extension should run on only one MID Server per VLAN. Multiple MID Server recipients on the same VLAN causes duplicate data in the CMDB. If network devices are separated by VLANs, multiple MID Servers may have trap collectors installed.

To configure multiple SNMP trap collector extensions, configure each in a separate record, with a unique name, and a designated MID Server.

**Configure the SNMP Trap Collector Extension**

For the SNMP trap collector extension to receive traps from network devices, each device must designate the MID Server that runs the SNMP trap collector extension as a recipient of the trap.

Role required: admin

1. Navigate to **MID Server > Extensions** > **MID SNMP Trap Listener**
2. Click **New** or open an existing extension.
3. Fill in the fields from the table, as appropriate.
4. Click **Submit** or **Update**.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for this SNMP trap collector extension for easy identification.</td>
</tr>
<tr>
<td>Short description</td>
<td>A description of the MID Server extension, if more description than the Name is necessary.</td>
</tr>
<tr>
<td>Extension</td>
<td>[Read-Only] The extension type is automatically set to TrapExtension.</td>
</tr>
<tr>
<td>Field name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>UDP port</td>
<td>The port number that your network hardware uses when sending a trap to the designated MID Server. Port numbers 1024 and above are recommended. Port numbers 1023 and lower may be system reserved and can result in access violations for MID Servers that are not running with administrative credentials.</td>
</tr>
<tr>
<td>Status</td>
<td>[Read-Only] The status of the trap collector extension. This field is blank until the extension is run. After it is run, the value may be:</td>
</tr>
<tr>
<td></td>
<td>• Started: The extension is running.</td>
</tr>
<tr>
<td></td>
<td>• Stopped: The extension is not running.</td>
</tr>
<tr>
<td></td>
<td>• Offline: The MID Server is down.</td>
</tr>
<tr>
<td></td>
<td>• Error: The extension failed with an error.</td>
</tr>
<tr>
<td>Execute on</td>
<td>The location for running this extension: a [Specific MID Server] or a [Specific MID Server Cluster]. The recommended setting is [Specific MID Server]. Network hardware typically has to be configured to send to a specific IP address. If the listener moved to a different MID Server in the cluster, the trap would not be received.</td>
</tr>
<tr>
<td>MID Server</td>
<td>The name of the designated MID Server if you selected [Specific MID Server] in the Execute on field. The name of the designated MID Server cluster if you selected [Specific MID Server Cluster] in the Execute on field. If you selected [Specific MID Server Cluster], a ServiceNow algorithm determines which server in the cluster runs the extension.</td>
</tr>
<tr>
<td>Executing on</td>
<td>[Read-Only] The name of the MID Server on which the extension is running. This field shows the name of the MID Server even if the MID Server is down. If the extension is stopped by the user, this field is empty.</td>
</tr>
</tbody>
</table>

5. **In Related Links**, run any of the following actions against the SNMP trap collector extension:

<table>
<thead>
<tr>
<th>Related Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Starts the extension if it is currently not running. The extension is started on the configured MID Server and port number.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the running extension on the configured MID Server. No action is taken if the extension is not running.</td>
</tr>
<tr>
<td>Restart</td>
<td>Stops, then starts the extension on the configured MID Server and port number.</td>
</tr>
<tr>
<td>Test</td>
<td>Verifies that the configured MID Server can run the SNMP trap collector extension on the specified port. Running a test does not affect any extensions that are currently running.</td>
</tr>
</tbody>
</table>
Securing and encrypting MID Server data

After configuring your MID Server, you can add security by encrypting MID Server parameter values in the config.xml file. Encryption protects data that the MID Server returns to the ECC Queue. Other available security options include the authorization of SOAP requests, restricting access to the MID Server configuration file, and establishing secure socket layer (SSL) connections.

How MID Server password encryption works

The username and password are initially set in the config.xml file on the MID server. When the MID server retrieves the credentials, it replaces the clear-text password with an encrypted password automatically, using an AES128 encryption algorithm. The MID server also maintains an encryption key that is generated each time it starts and remains in memory and not on the hard disk. When credentials need to be sent from the instance to the MID server, the following process takes place:

1. The instance retrieves the encrypted password and the unencrypted username from the instance database table.
2. The instance decrypts the encrypted password, and then re-encrypts it using the MID server encryption key.
3. The username and re-encrypted password are sent to the MID Server through the encrypted TLS session was already established between the MID server and the instance.
4. The MID server receives the credentials and decrypts the password in memory before using the credentials for remote operations. At no point is the credential password stored on the disk in an unencrypted format.

Security options

The MID Server provides built-in security options for other content in the configuration file, such as the default encryptor, Windows Data Protection API, and options for custom encryption.

Encrypt or decrypt MID Server configuration file values
You can encrypt and decrypt any value in the MID Server config.xml file.

ECC queue data encryption with the automation API
Use the automation API to encrypt sensitive probe data that is sent from an instance to the MID Server through the ECC Queue.

MID Server configuration file security
Protect sensitive MID Server configuration data in the config.xml file using internal and external data encryption and external data storage.

Rekey a MID Server
Rekey a MID Server to force it to restart and generate a new private key. Typically, this process is only necessary if the MID Server keystore is compromised.

Add SSL certificates for the MID Server
Add certificates to the MID Server to communicate over SSL.

MID Server authentication credentials and SOAP requests
For added security, enforce basic authentication on each incoming SOAP request to the MID Server.

Attach a script file to a file synchronized MID Server
Attach a script file and synchronize it to a MID Server to prevent Windows enhanced security from blocking MID Server download files it determines are dangerous.

Encrypt or decrypt MID Server configuration file values
The value of any MID Server parameter in the config.xml file can be encrypted. The attributes for all encrypted values are managed from within the configuration file, including the security attribute of the login password.

Role required: admin
1. Navigate to the agent directory that was created when the MID Server was installed and open the config.xml file using a text editor such as WordPad.

2. Locate or add the parameter you want to encrypt. For example, you might want to protect your proxy server passwords by configuring this parameter:

   `<parameter name="mid.proxy.password" value="securepassw0rd"/>

3. Add the encryption attribute `secure="true"`.

   `<parameter name="mid.proxy.password" secure="true" value="securepassw0rd"/>

4. Restart the MID Server.

5. Open the config.xml file

   The encrypted password appears as follows:

   `<parameter name="mid.proxy.password" secure="true" value="encrypted:rhrfUNYRzZAI8/BkTtZmNA=="/>

6. To decrypt this or any other value in the config.xml file and display the value in clear text:

   a) Stop the MID Server.
   b) Set the `secure="true"` attribute to `false`.
   c) Replace the encrypted value with the clear text value.
   d) Restart the MID Server.

---

**ECC queue data encryption with the automation API**

The automation API encrypts sensitive probe data that is sent from an instance to the MID Server through the ECC Queue.
You can use the automation API to encrypt data that you send from a custom application to the ECC queue and prevent that data from appearing in clear text. For example, you can encrypt a password used by a MID Server to authenticate on a REST endpoint.

**Methods**

The API provides these methods:

- `encrypt()`
- `isEncrypted()`

The following example shows how you might call these methods:

```javascript
var automation_api = new sn_automation.AutomationAPI();
var password = 'xyz';
var encrypted_password;
if (automation_api.isEncrypted(password))
  encrypted_password = password;
else
  encrypted_password = automation_api.encrypt(password);
```

The `encrypted_password` value can then be passed safely to the ECC Queue and on to the desired MID Server.

**MID Server configuration file security**

Sensitive MID Server configuration data can be protected using several different schemes, including internal and external data encryption and external data storage.
The MID Server provides the following built-in security options for content in the `config.xml` file:

- **Default security provider**: Secures the data in the `config.xml` file by encryption. When the MID Server is restarted, any unencrypted data is encrypted and written to the `config.xml` file. The default security provider offers these encryption options:
  - **Default encryptor**: Default process for encrypting data in the MID Server `config.xml` file. See Encrypt or decrypt MID Server configuration file values for details.
  - **Windows Data Protection API (DPAPI)**: The operating system performs the data encryption, rather than the MID Server. DPAPI encryption is based on the logged in user's account. When this scheme is used, the data can only be decrypted by the same user account. If the account changes, the data must be re-encrypted.
  - **Custom encryption**: Implement the `IMidServerEncrypter` interface to create your own custom encryption scheme to manage sensitive `config.xml` data.

- **CyberArk**: Data security is provided by CyberArk's Privileged Account Security system, which moves sensitive data from the `config.xml` file to a secure CyberArk vault. This solution does not encrypt the data.
- **Custom external storage**: Implement the `ISecuredConfigProvider` interface to create your own custom external storage system to manage sensitive `config.xml` data.
Encrypt MID Server configuration data with DPAPI

Windows Data Protection API (DPAPI) encrypts sensitive data from the `config.xml` file, based on the MID Server user account.

Role required: admin

DPAPI encryption provides another level of security for data such as credentials, IP addresses, and URLs in the MID Server `config.xml` file. The operating system performs the data encryption, rather than the MID Server. DPAPI encryption is based on the logged in user's account. When this scheme is used, the data can only be decrypted by the same user account. If the account changes, the data must be re-encrypted.

1. Open the `config.xml` file in a text editor. This file is located in the `/agent` folder in your MID Server installation path.
2. Enable this parameter and value:
   ```xml
   <parameter name="mid.secure_encrypter" value="com.service_now.mid.services.config.WindowsDPAPIEncrypter"/>
   ```
3. Save the configuration file.
4. Restart the MID Server. 
Any values in clear text in the config.xml file are encrypted by the operating system.

5. Follow this procedure if you need to change the MID Server user account that is used for encryption.
   a) Stop the MID Server service.
   b) Open the config.xml file in a text editor.
      This file is located in the /agent folder in your MID Server installation path.
   c) Re-enter all the encrypted values in clear text.
   d) Make the changes to the MID Server user account in the ServiceNow® instance.
   e) Restart the MID Server service.
      The data is re-encrypted by the operating system, based the new MID Server user account.

Use CyberArk as a secure configuration provider

You can use a CyberArk vault to secure any sensitive data from the MID Server config.xml file.

Role required: admin

CyberArk is commonly used to secure credentials in its external vault. However, a MID Server parameter in the config.xml file enables you to store other types of data in CyberArk.

1. Open the config.xml file in a text editor.
   This file is located in the /agent folder in your MID Server installation path.

2. Enable this parameter and value:
   <parameter name="mid.secure_config.provider" value="com.service_now.mid.services.config.CyberArkSecuredConfigProvider"/>

3. Configure specific data to secure in the CyberArk vault, as shown in these examples.
   a) Secure the MID Server credentials by setting this parameter to match the ID and Type for that data in your CyberArk configuration.

   <parameter name="mid.instance.username" secure="true" value="cyberark: id=<CyberArk ID>, type=<CyberArk type>"/>
   <parameter name="mid.instance.password" secure="true" value="cyberark: id=<CyberArk ID>, type=<CyberArk type>"/>

   b) Secure the URL of the instance by setting this parameter to match the ID and Type for that data in your CyberArk configuration.

   <parameter name="url" secure="true" value="cyberark: id=<CyberArk ID>, type=<CyberArk type>"/>

4. Save the configuration file.

5. Restart the MID Server.

Change MID Server configuration file security schemes

The MID Server provides several schemes for securing sensitive data in the config.xml file and allows you to switch between these options to suit your security requirements.

Role required: admin

1. Stop the MID Server service.

2. Open the config.xml file in a text editor.
   This file is located in the /agent folder in your MID Server installation path.
3. Re-enter all the encrypted values in clear text.
4. Disable the previous security scheme and configure the MID Server to use the new provider.
5. Restart the MID Server service.
   The data is re-secured or encrypted, based on the security scheme you have selected.

MID Server ISecuredConfigProvider interface

Use the methods in this interface to create custom providers that manage secured parameter values in the MID Server config.xml file.

Note: These methods are contained in the snc-automation-api.jar file, located in the MID Server installation folder.

initialize

This method initializes the provider with additional configuration parameters and does not return a value.

Example

```java
void initialize(java.util.Properties properties, IMidServerEncrypter encrypter)
  throws java.lang.Exception
```

Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>properties</td>
<td>Initialization properties.</td>
</tr>
<tr>
<td>encrypter</td>
<td>Encrypter to use if the provider is encryption based.</td>
</tr>
</tbody>
</table>

Exception

```
java.lang.Exception
```

isParameterValueSecured

This method checks to see if the parameter value has been secured or not. This method returns a boolean type value.

Example

```java
boolean isParameterValueSecured(java.lang.String paramValue)
```
Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>paramValue</td>
<td>The parameter value.</td>
</tr>
</tbody>
</table>

Returns

The parameter returns true if the parameter value is secured.

**secureParameterValue**

This method secures the parameter value if it has not been secured. This method returns a string type value.

**Example**

```java
java.lang.String secureParameterValue(java.lang.String unsecuredParameterValue) throws java.lang.Exception
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>unsecuredParameterValue</td>
<td>The unsecured parameter value.</td>
</tr>
</tbody>
</table>

Returns

This method returns the unsecured parameter value.

**Exception**

```java
java.lang.Exception
```

**unsecuredParameterValue**

This method returns the unsecured value of the parameter. This method returns a string type value.

**Example**

```java
java.lang.String unsecuredParameterValue(java.lang.String parameterName) throws java.lang.Exception
```
Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>parameterName</td>
<td>The parameter name.</td>
</tr>
</tbody>
</table>

Returns

This parameter returns the unsecured value.

Exception

`java.lang.Exception`

**MID Server IMidServerEncrypter interface**

Use the methods in this interface to create a custom external encrypter for the MID Server `config.xml` file.

*Note:* These methods are contained in the `snc-automation-api.jar` file, located in the MID Server installation folder.

**initialize**

This method initializes the encrypter with additional configuration parameters and does not return a value.

**Example**

```java
void initialize(java.util.Properties properties)
    throws java.lang.Exception
```

**Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>properties</td>
<td>Initialization properties.</td>
</tr>
</tbody>
</table>

**Exception**

`java.lang.Exception`

**encrypt**

This method encrypts the unencrypted data and returns a `byte[ ]` type value.
Example

```java
byte[] encrypt(byte[] unencryptedData)
    throws java.lang.Exception
```

Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>unencryptedData</td>
<td>The data unencrypted.</td>
</tr>
</tbody>
</table>

Returns

Encrypted data

Exception

`java.lang.Exception`

decrypt

This method decrypts encrypted data and returns a `byte[]` type value.

Example

```java
byte[] decrypt(byte[] encryptedData)
    throws java.lang.Exception
```

Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>encryptedData</td>
<td>The data decrypted.</td>
</tr>
</tbody>
</table>

Returns

Decrypted data.

Exception

`java.lang.Exception`
Rekey a MID Server

Rekey a MID Server to generate a new private key. Private keys are used to decrypt automation credentials, so that MID Servers can transmit information securely. Key pairs are initially generated when a MID Server is validated, and MID Servers should be rekeyed periodically to meet security requirements.

Role required: admin

When the MID Server comes back online, the system automatically validates the new key, and the MID Server resumes processing automation tasks.

Automation credentials are secured by encrypting them in the instance with the MID Server’s trusted public key prior to transmission. When the MID Server is created, it generates a keypair, consisting of a public and private key. After the MID Server is validated, it can use the private key to decrypt automation credentials. You should occasionally rekey the MID Server to meet your organization’s security requirements.

1. Navigate to MID Server > Servers.
2. Open the MID Server whose keypairs you want to rotate.

Add SSL certificates for the MID Server

Configure the MID Server to connect to a source over SSL.

Role required: admin
You can add certificates to the MID Server if you want communication to occur over SSL. You can add these certificates to the cacerts keystore file:

- Signing Certificate Authority (CA) certificate
- MID Server certificate

1. Open a command prompt and navigate to the folder containing the JRE keytool.
   This is the location of the JRE you installed. An example path might be: `C:\Program Files\Java\jre1.8.0_161\bin`

2. Import a certificate into the MID Server's cacerts keystore, using this command:
   ```
   keytool -import -alias <certificate alias> -file "<path to certificate>" -keystore "<path to the JRE>\lib\security\cacerts"
   ```
   For example, you might enter: `keytool -import -alias MyCA -file "C:\myca.cer" -keystore "C:\Program Files\Java\jre1.8.0_161\lib\security\cacerts"

   **Note:** The keytool prompts you for a certificate password. If the certificate is for a CA, the keytool also asks whether to trust the certificate authority. To add a certificate to an instance, see Upload a certificate to an instance.

**MID Server authentication credentials and SOAP requests**

Set basic authentication credentials to update the web service invocation data. For added security, you can enforce basic authentication on each incoming SOAP request to the MID Server.
Basic authentication credentials and SOAP requests

You can enforce basic authentication on each request. The MID Server is not able to communicate through a proxy server if the proxy server supports only NTLM authentication. You can use basic authentication with a proxy server or create an exception for the MID server host.

Supplying basic authentication information, regardless of whether it is required, has an added advantage. The web service invocation creates or updates data using the supplied credentials. For example, when you create an incident record, the journal fields have the user id of the basic authenticated user instead of the default Guest user. This behavior allows you to identify data added by a specific MID Server.

You can set basic authentication credentials for SOAP requests. Each SOAP request contains an Authorization header as specified in the Basic Authentication protocol.

Note: The setting for enforcing strict security controls how the instance uses the credentials you provide for the MID Server. When the setting is enabled, you must provide a user ID with access to the tables the MID Server is trying to access. When the setting is disabled, any valid user ID allows the MID Server to access to all tables.

Note: To learn more about properties that affect SOAP request processing, see Basic auth: SOAP requests in Instance Security Hardening Settings.

Require basic authorization for incoming SOAP requests

Enforce basic authentication on each incoming SOAP request to the MID Server.

Role required: admin

1. Navigate to System Properties > Web Services.
2. Select the check box for Require basic authorization for incoming SOAP requests.
3. Click Save.
4. To provide basic authentication credentials for a MID Server, navigate to C:\Program Files \ServiceNow\<MID Server name>\agent and edit the config.xml file, as follows:
   a) Find the element <parameter name="mid.instance.username" value=""/> and enter the instance administrator user name as the value.
For example, you might enter `<parameter name="mid.instance.username" value="admin"/>`.

b) Find the element `<parameter name="mid.instance.password" value=""/>` and enter the configured password for this instance as the value. For example, you might enter `<parameter name="mid.instance.password" value="abc123"/>`.

**Attach a script file to a file synchronized MID Server**

You can attach a script file to synchronize to a connected MID Server. Windows Internet Explorer enhanced security blocks downloaded files that it determines are potentially dangerous. However, synchronizing the files avoids this security problem.

Role required: **admin**

Enhanced security in Windows browsers, such as Internet Explorer, blocks downloaded files that it determines are potentially dangerous. This would block files downloaded for use by the MID Server. You would need to unblock each file manually through the browser.

To get around this issue, use file synchronization. File synchronization requires you to proactively take script files from your instance and save them on the MID Server. The files on the instance and the MID server stay synchronized, but there is no longer any need for the MID Server to download the whole file. File synchronization also protects any updates you make in those script files from being overwritten during the upgrade of an instance.

You can attach multiple files, but the last attached file gets synchronized to the MID Server. If you delete the attachment, the script file becomes inactive, and the synchronized file is deleted from the MID Server.

1. Navigate to **MID Server > Script Files**.
2. Open the file to which you would like to attach the script file, or click **New** to create a new file.
3. Select **Use attachment**, and then click the paperclip icon to add the attachment.

   When **Use attachment** is checked, an attached script file overrides the script contained in the **Script** field. If this check box is cleared, the script in the **Script** field is used instead of the attachment.

   The script file attachment name must match the MID Server script file name, since the record can contain other attachments.
4. Click **Update** to initiate the synchronization process. Ensure that the file name matches the script name. If you receive the error message: *File type not permitted or mime type does not match the file content*, request that your administrator turn off mime type validation on attachments. The system property `glide.security.file.mime_type.validation` controls this setting.

**Enable script file synchronization for Windows enhanced security**

Windows Internet Explorer enhanced security blocks downloaded files that it determines are potentially dangerous.

Script files synchronized with the MID Server are stored on the instance in the MID Server Script File [ecc_agent_script_file] table, which you can access in the **MID Server > Script Files** module.

When the MID Server first connects to the instance, the instance creates a directory called \scripts in the MID Server root. The instance then creates a parent directory in the path \scripts\<parent name> using definitions from the ecc_agent_script_file table. Finally, the instance creates the script files themselves inside the parent directory using the records from the ecc_agent_script_file table.

The record for the parent directory looks like this:

![Parent directory record](image)

The instance creates each script file in the parent directory on the MID Server using the record **Name** from the ecc_agent_script_file table as the file name and the **Script** field payload as the file contents. A script file record looks like this:

![Script file record](image)
The synchronization of the script file continues to work as if the script was manually added to the form. See Attach a script file to a file synchronized MID Server for instructions on how to attach a script file.

**Note:** The MID Server Script File [ecc_agent_script_file] table is domain separated. You can create versions of these policies that only a MID Server from the same domain can use. For instructions, see Set up domain separation for MID servers.

**MID Server upgrades**

Upgrade MID Servers manually, or automatically through their host computers. The instance automatically tests to identify issues before MID Servers upgrade. Pin MID Servers to specific versions using system properties.

**Warning:** The MID Server cannot auto-upgrade on a Windows host if the Windows Application Experience service is disabled. For information on the error that is displayed and instructions for re-enabling this service, see KB0597552.
Access to the MID Server download site

The MID Server host computer must have access to the ServiceNow download site at install.service-now.com to upgrade automatically. If you have a self-hosted ServiceNow environment that blocks access to the download site, you must import the MID Server installer package into your MID Server hosts manually. For instructions, see KB0760123 in the Self-Hosted knowledge base.

Upgrade methods

- **Automatic**: Allow the instance to automatically upgrade the MID Server. This functionality is available by default. Automatic upgrade occurs:
  - Every hour, when the MID Server checks with the instance to see if there is a different version available for upgrade. You cannot modify this time period.
  - When the instance is upgraded and the MID Server for that version is different than the version currently on the MID Server.
  - When the MID Server pre-upgrade test passes without an error. Any errors encountered during this automatic test prevent the upgrade from occurring until the issues are resolved. The pre-upgrade test is enabled by default, but can be disabled by adding and setting a system property.
  - During an automatic upgrade, the MID Server automatically verifies the digital signature of upgrade packages to ensure they haven’t been tampered with. The MID Server downloads upgrade patches one by one and stores them in the file system. After a patch is downloaded, the MID Server verifies its digital signature and throws an exception if the verification fails. The error will be recorded in the agent log and the MID Server issue table. Set the property `mid.log.level=debug` to see detailed verification debug messages.

- **Manual**: Manually start the upgrade by clicking a related link on the MID Server record. Use this method when you do not want to wait until the next hourly automatic update or if your upgrade failed and you want to force an upgrade. See Upgrade the MID Server manually for instructions.

To manually verify the signature of an installation or upgrade package, use the jarsigner tool which is available for free with JDK. The following is the jarsigner command to initiate the verification:

```
Jarsigner -verify -verbose -certs -strict <zip-file>
```

The output should be similar to the following example:

```
- Signed by "CN=ServiceNow Inc., O=ServiceNow Inc., L=Santa Clara, ST=California, C=US"
Digest algorithm: SHA-256
Signature algorithm: SHA256withRSA, 2048-bit key
Timestamp digest algorithm: SHA-256
Timestamp signature algorithm: SHA256withRSA, 2048-bit key
jar verified.

The signer certificate will expire on 2021-08-09.
The timestamp will expire on 2029-03-22.
```

The Upgrade state

The instance initiates the upgrade by sending the `autoUpgrade` system command to the MID Server. Starting with MID Servers upgrading from an Istanbul version MID Server, the MID Server Status is
changed to **Upgrading** while the upgrade is running. The **Upgrading** state is similar to the **Paused** state. This is done to avoid potential miscommunication between the new version of the instance and the previous version of the MID Server during upgrade. For the upgrade to run, MID servers must be in the **Up** state and must be **validated**.

While in the **Upgrading** state, you cannot resume or restart the MID Server. However, you can perform the same actions that you can when the MID Server is in the **Paused** state. After a successful upgrade, the queued output is sent to the instance and the MID Server starts retrieving new commands to process. The status also changes to **Up**.

When the instance sends the `autoUpgrade` system command to the MID Server, if it is **Down** or **Paused**, or if it has not been validated, the command remains in the ECC Queue until the MID Server status changes to **Up**. Then the command is processed.

**Note:** If you are using an Istanbul instance but you are upgrading a pre-Istanbul MID Server to Istanbul, these upgrade states are not available. They are only available for MID Servers that are already on Istanbul.

**Failed upgrades**

Failed upgrades are handled differently based on the version you are upgrading to:

- Upgrade to another major release (such as Istanbul to the next full release): the status changes to **Upgrade Failed**.
- Upgrade from a minor version within a release (such as Jakarta patch 1 to patch 2): the MID Server continues using the version it is currently running. It does not perform the upgrade and the status eventually changes to **Up**, assuming the MID Server was already functioning properly.
- Automatic upgrade on Linux systems from Madrid or lower to New York: the MID Server will fail to automatically upgrade. The MID Server service must be manually reinstalled to complete the upgrade.

**Upgrading MID Servers in the Down state**

If a MID Server is in the **Down** state, it cannot process the upgrade command. When the MID Server changes to **Up**, it immediately checks to see if an upgrade is necessary. If it does need to upgrade, the upgrade process starts before the MID Server processes any other commands.

**Upgrade error messages**

The MID Server can display the following upgrade error messages.

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to refresh packages</td>
<td>Generic error when the error is not handled by a defined error message.</td>
</tr>
<tr>
<td>Failed to query instance for MID Server buildstamp</td>
<td>Instance is unavailable or there is a major version mismatch between the MID Server and the instance.</td>
</tr>
<tr>
<td>Not a valid package buildstamp</td>
<td>InstanceInfo returned an assigned buildstamp that was not in the correct format, such as a version mismatch.</td>
</tr>
<tr>
<td>Message</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Method failed (&lt;instance URL&gt;) HTTP/1.1 409 Conflict with code: 409</td>
<td>MID Server auto-upgrade request rejected when number of concurrent upgrades exceeds 2. The configured number of available semaphores for MID Server upgrades on the instance is set at 2 to prevent performance degradation.</td>
</tr>
</tbody>
</table>

**Note:** The MID Server re-sends the request every 20 seconds until it can get the semaphore.

**MID Server Upgrade History**

Use the MID Server Upgrade History module for troubleshooting problems with MID Server upgrades. The module contains a record of each instance upgrade. Those records provide step-by-step status details for each MID Server's upgrade process. If an error occurs, it is noted in the step and a message is dynamically generated with further details. For further information, see MID Server Upgrade History.

**MID Server pre-upgrade check**

The instance automatically tests the MID Server's ability to upgrade on your system prior to the actual upgrade, to identify issues that could cause a MID Server outage or require re-installation.

Each MID Server contains an AutoUpgrade monitor that compares the MID Server version with that of the instance to determine if the MID Server needs to upgrade. If the AutoUpgrade monitor discovers that the MID Server version is out of date, the monitor runs pre-upgrade validation tests for that MID Server. If an issue is detected, a message is logged to the MID Server Issue [ecc_agent_issue] table, and the upgrade is blocked. The AutoUpgrade monitor continues to run every hour, until all the tests pass. If there are no blocking issues, the MID Server downloads the appropriate upgrade package and begins the upgrade process.

Failed tests leave the MID Server in one of these states:

- **Upgrade Failed**: For upgrades to a different release family, such as from London to Madrid.
- **Up**: For upgrades within the same release family, such as an upgrade to a patch.

Errors, such as insufficient disk space for the installer or lack of connectivity to the download server, are written to both the MID Server agent log and to the MID Server Issue [ecc_agent_issue] table. These errors are published before the actual MID Server upgrade occurs and must be resolved before the upgrade can continue. You can view issues from the MID Server Issue [ecc_agent_issue] table in any of these locations:

- **MID Server Issues** related list in a MID Server record.
- **MID Server > Server Issues** navigation module.
- **MID Server Issues** gauge on the MID Server dashboard.

**Pre-upgrade tests**

The pre-upgrade validation tests check these requirements:

- At least 1 GB of free disk space
- Access to the download site at install.service-now.com
• Permission to execute these file operations:
  • Extract a ZIP archive to a temp folder.
  • Copy files from the temp folder to the agent folder.
  • Read a text file.
  • Delete the pre-upgrade contents.

• For Windows, ensure that the Log On As user for the Windows service is either LocalSystem or a user that is part of the local Administrator group. By default, domain administrators are added to the local Administrator group when joining a computer to a domain. If the PowerShell script that performs this test does not return the expected output, the system logs a warning to the MID Server Issue [ecc_agent_issue] table, but the test passes.

Data provided

When the instance encounters issues during the pre-upgrade check, it populates these fields in the MID Server Issue [ecc_agent_issue] table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last detected</td>
<td>Date and time the issue was last detected.</td>
</tr>
<tr>
<td>Short description</td>
<td>Contents of the generated message that specifies a possible issue with available disk space, download server access, or file permissions.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Name of the MID Server affected by a pre-upgrade test failure.</td>
</tr>
<tr>
<td>Issue source</td>
<td>The process that identified the issue. For all issues with MID Server pre-upgrade testing, the source is UpgradeCheck.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the issue. Possible states are:</td>
</tr>
<tr>
<td></td>
<td>• New: Starting state when the instance creates the issue.</td>
</tr>
<tr>
<td></td>
<td>• Acknowledged: State set by the administrator when they first examine the issue.</td>
</tr>
<tr>
<td></td>
<td>• Resolved: Ending state, set by the instance, indicating that the issue has been resolved. If the scheduled job does not encounter the issue when it runs again, the instance automatically sets the state to this value.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain for the MID Server. For all issues derived from MID Server pre-upgrade testing, the domain value is inherited from the domain of the MID Server user.</td>
</tr>
<tr>
<td>Count</td>
<td>Number of times an issue has been detected. Each time the pre-upgrade tests run and encounter the same issue, the AutoUpgrade monitor increments this field.</td>
</tr>
</tbody>
</table>
Errors that block the upgrade

These messages describe issues detected by the pre-upgrade test and published to the MID Server Issue [ecc_agent_issue] table. Failure of any of these tests blocks the upgrade.

- **Not enough free disk space. The system reports <n> bytes free**: This message is displayed when less than 1 GB of free disk space is detected on the MID Server host. This error is also written to the MID Server agent log.
- **Unable to download updates from the install server**: This message indicates that either the MID Server host does not have permission to download the installation package from install.service-now.com, or network problems prevent connection. This error is also written to the MID Server agent log.
- **Unable to extract contents of pre upgrade check zip**: This message indicates that the service account on the MID Server host does not have permission to extract the pre-upgrade ZIP archive to the temporary folder specified by the system property, java.io.tmpdir. On a UNIX host, the value for this property is typically /tmp or /var/tmp. On Microsoft Windows hosts, the path is c:\WINNT\TEMP.
- **Unable to create folder <upgrade check file path>**: This message indicates that the MID Server service account does not have permission to create the upgradeCheck folder for the pre-upgrade checking files in the agent/package path.
- **Unable to verify file permissions: <message>**: This message indicates an exception has occurred when checking file permissions, such as a file that does not exist or access failure.
- **MID Server Windows Service is not running as LocalSystem or a local Administrator**: This message warns that the Windows service is not running with the desired permissions.

Non-blocking warnings

These warnings are displayed in the MID Server Issue [ecc_agent_issue] table and do not prevent a Windows MID Server from upgrading:

- **WARN: Unable to parse $logOnAsUser**: This message warns that the Log On As User value for the Windows service is not in either of these expected formats:
  - user@domain.company.com
  - domain\user
- **WARN: Unable to look up Log On As user's groups**: When the instance attempts to look up the logged on user's group memberships, it executes the net user <username> command. The instance expects a certain output structure by the Windows service from this command and issues this warning if the expected output does not match the actual output.

These PowerShell warnings are written only to the MID Server agent log. Because PowerShell is not required to use a MID Server, these configuration issues do not prevent a Windows MID Server from upgrading. However, these warnings might indicate issues in your environment that require attention.

- **Skipping PowerShell upgrade checks since PowerShell is not usable**: PowerShell 2.0 (at a minimum) is not installed or powershell.exe is not available to the MID Server service user.
- **Continuing with upgrade, but the following issue was encountered during upgradeCheck: <exception message>**: This message indicates that there was an issue running the PowerShell portion of the pre-upgrade tests.
Disabling the pre-upgrade check

A MID Server configuration parameter called `mid.upgrade.run_precheck` is set to `true` by default, which allows the automatic pre-upgrade test to run. To disable these tests for a single MID Server, add this parameter to that MID Server’s `config.xml` file and set it to `false`. To disable these tests for all MID Servers, add a new record to the MID Server Property [ecc_agent_property] table called `mid.upgrade.run_precheck`. Set the value of this property to `false` and leave the `MID Server` field blank.

Pinning a MID Server to a specific version

You can pin all the MID Servers in your environment to a specific version by setting a system property, or you can configure specific versions for individual MID Servers.

**Note:** Under most circumstances, do not pin the MID Server to a specific version. Pinning the MID server can make it out of sync with the instance, and lead to broken functionality. Instead, let the instance determine which MID Server version to use.

Version control properties

These system properties control the version for all MID Servers:

- **mid.buildstamp**: Identifies the MID Server version with an identifier based on the date of the build. This property uses the format of `mm-dd-yyyy-hhmm`. The MID Server checks for version information hourly. If no override version is configured, the MID Server looks at the `mid.buildstamp` property for the version to use. This property resets itself to the default version (the version that matches your instance version) when the instance is restarted or upgraded, so any user changes are lost at that time. The system appends the release name and patch information to the date and time format.

  **Caution:** This property is not visible by default and should not be configured.

- **mid.version.override**: Sets an override condition for the current version for all MID Servers in your environment. This action pins the MID Servers to a single version and disables the automatic upgrade feature. This property is not visible in the base system and must be added to the System Property [sys_properties] table when it is set. For details, see Add a system property.

  When the MID Servers check the version each hour, they look at the `mid.version.override` property first. If this property is empty, the MID Servers get their version information from the `mid.buildstamp` property. If an override version is configured, the MID Servers use this value and ignore the version information in the `mid.buildstamp` property. This override value remains when the instance is restarted and is passed to the MID Servers.

  **Attention:** The value in the `mid.version.override` property is cleared during an upgrade, which forces the MID Server to reset itself to the version in the `mid.buildstamp` property.

Version control configuration parameter

To pin specific MID Servers on a desired version, set the `mid.pinned.version` parameter with the name of that version in the `config.xml` file of each MID Server. Use the format `<version>-mm-dd-yyyy`. This setting overrides the property setting for the pinned MID Server version. For instructions, see Add a MID Server parameter.
Note: The value set in this parameter is not affected by an upgrade.

Upgrade the MID Server manually

You can manually upgrade MID Servers at any time if you do not want to wait for the automatic upgrade.

Role required: mid_server or admin

For the upgrade to run, MID servers must be in the Up state and must be validated.

The MID Server is upgraded to the version specified by build stamp on the instance, or by the upgrade property that you specify.

1. Navigate to Discovery > MID Servers or Orchestration > MID Server Configuration > MID Servers.
2. Open the record of the MID Server that you want to upgrade.
3. Click Upgrade MID under Related Links.
4. Confirm that you want to perform the upgrade.

Resolving MID Server issues

Troubleshoot problems with the MID Server to find solutions. Monitor the MID Server to receive alerts about issues as they occur. Troubleshooting procedures exist to resolve specific problems with the MID Server. The Knowledge Base on Hi contains several articles to help you troubleshoot MID Server issues.

Monitor the MID Server

Monitoring a MID Server involves verifying entries in log files, confirming network connectivity, and checking MID server status.

- If the MID Server is on a Windows host, navigate to the Windows Services console, locate the service name that matches the name that appears from the wrapper-override.conf file. If the MID Server process is the only Java process running on the host, monitor the memory used by java.exe and alert on less than the maximum configured memory defined in the ~agent\conf\wrapper-override.conf folder.
- Ensure that the agent0.log.0.lck file appears in the ~agent\logs folder to confirm that the MID Server running and logging system activity in the agent0.log.0 file.
- Review the following logs for warning, critical, and severe errors: ~agent\logs\agent0.log.0~
  \agent\logs\wrapper.txt See Manage ECC Queue content for a MID Server to see how to open log entries from the instance.
- Test MID Server connectivity to confirm that the MID Server host is able to communicate with the instance. Resolve any issues with the network connectivity such as conflicts with firewalls, access control lists, and routing errors.
- From the MID Server instance, navigate to the MID Servers page, and review the status of the MID Server. For additional information, click a Name.
- Set up email, SMS, and push notifications to alert you when issues occur with MID servers. The MID Server Down notification is enabled by default. See Notifications for details.

Troubleshooting procedures

The following procedures provide information on resolving specific problems with the MID Server.
Knowledge Base articles also cover a wide range of issues. If you are encountering problems which are
not covered in these procedures, search the Knowledge Base for related articles. For instance, if you are experiencing symptoms such as the MID Server going down or not responding, or CIs being duplicated during discovery, see KB0597571 for information and recommended solutions.

MID Server active issues
The ServiceNow® instance has a dedicated table that publishes active issues with MID Servers and alerts administrators when a MID Server is in danger of exceeding its resources.

MID Server fails to start
The MID Server cannot run if another MID Server on the host has the same name or if multiple Windows services have the same executable path.

Active MID Server post-cloning credential issues
The system provides automatic processes to detect and notify you of possible MID Server credential issues after instance cloning.

MID Server resource threshold alerts
The instance displays warnings when a MID Server breaches its resource thresholds for CPU and JVM memory usage, enabling users to create email notifications or custom scripts when a breach occurs.

MID Server user connectivity issues
The instance writes issues involving MID Server user logins and network connectivity to the MID Server Issue [ecc_agent_issue] table and creates events you can use in custom scripts or to send email notifications.

Interpreting MID Server user debugging output
Debugging output from the system log is available in either a summary or detailed view for MID Server user issues, but must be enabled manually.

MID Server Upgrade History
Use this module to troubleshoot errors that occur during the MID Server upgrade process. The MID Server Upgrade Histories table contains a record of each instance upgrade. The MID Server Upgrade Stages table shows the status of each MID Server and its upgrade progress, including any errors encountered.

MID Server active issues
The ServiceNow® instance has a dedicated table that publishes active issues with MID Servers and alerts administrators when a MID Server is in danger of exceeding its resources.

The MID Server Issue [ecc_agent_issue] table displays a number of common issues that a MID Server can experience, as they occur. Error checking processes attempt to pinpoint the most likely cause of the issue. Informative error messages name the affected MID Server and explain the possible cause of the issue. The ecc_agent_issue table retains its records for 30 days.

To access records in this table, navigate to MID Server > Server Issues.

Supported MID Server active issues:
- Bad user credentials after instance cloning.
- Unsupported Java Runtime Environment (JRE) on the MID Server host.
- Approaching resource thresholds for CPU usage and JVM memory.
- Errors detected during pre-upgrade testing.
- User authentication and authorization failures.
- Network connectivity interruptions and role configuration errors.
Example MID Server Issue record

**MID Server fails to start**

When a newly installed MID Server fails to start or shuts down prematurely, improper configuration could be to blame.

**Duplicate MID Server names**

When the MID Server service starts, it verifies that it is the only active (not down) MID Server with that name. If the MID Server discovers another active MID Server with the same name, the starting MID Server waits 5 minutes and sends another query. The MID Server repeats this query three times and logs each attempt in the agent log. If the MID Server still detects a duplicate after this cycle, it creates a record in the MID Server Issue [ecc_agent_issue] table and shuts down.
Upgraded MID Servers running multiple services

Beginning with the New York release, a batch file in the MID Server installer package ensures that only one Windows MID Server service is configured for an executable path (MID Server installation folder). Previous versions have not checked for this configuration. MID Servers upgraded to New York or later that run multiple services with the same executable path are prevented from starting. If you experience this issue, follow this procedure to reconfigure the MID Server to use only one service:

1. Delete the unwanted Windows service by running `sc.exe delete <service name>` from the command line.
2. Open the `wrapper-override.conf` file in the MID Server installation folder.
3. Change the `wrapper.name` and `wrapper.displayname` parameters to the service name that you want to keep.
4. Restart the MID Server.

Active MID Server post-cloning credential issues

The system provides automatic processes to detect and notify you of possible MID Server credential issues after instance cloning.

During an instance clone, the MID Server `[ecc_agent]` table is not copied from the source instance, but the User `[sys_user]` table is copied. As a result, the source MID Server user credentials copied into the target instance might not match those used by the existing set of MID Servers used by the target. Bad credentials can cause those MID Servers to be down for the target instance. Processes on the instance notify you if a MID Server is down from suspected bad credentials following an instance clone.

Table for post-cloning credential issues

The MID Server Issue `[ecc_agent_issue]` table stores active MID Server issues after an instance clone. Records in this table show a MID Server's current state, evaluation times, and the `Issue source`. For cases in which a MID Server for a cloned instance is down because of possible bad credentials, the `Issue source` is `InstanceClone`. Data from the MID Server Issue `[ecc_agent_issue]` table are displayed in a related list on a MID Server record. Records in this table are removed after 10 days, regardless of their state. Ongoing issues reappear as they occur.

Post-cloning cleanup script and scheduled jobs

A cleanup script called `Bad MID Server credentials after clone` runs on the target instance after cloning and calls a script include called `BadMIDCredentialAfterClone`. This script include schedules the execution of the following jobs on the Schedule Item `[sys_trigger]` table:

- `BadMIDCredentialAfterClone-1`: Runs 15 minutes after clone execution.
- `BadMIDCredentialAfterClone-2`: Runs 75 minutes after clone execution.

These jobs log to the MID Server Issue `[ecc_agent_issue]` table any MID Servers that existed on the target instance prior to the clone that are in the `Down` state. These MID Servers are not ready for normal processing and might be down due to invalid credentials resulting from the cloning process. The state of MID Servers added to the target instance after the clone is not evaluated.

Note: The MID Server log shows that the MID Server user associated with the target instance could not be authenticated or was missing the proper role.
Business rule that checks for bad credentials

The Check for bad MID credential after clone business rule monitors the MID Server [ecc_agent] table for MID Servers that are transitioning from Down to Up. If the business rule finds a MID Server making that transition, the rule attempts to find a matching MID Server in the MID Server Issue [ecc_agent_issue] table that has an issue source of InstanceClone and a state other than Resolved. If a match is found, the business rule updates the state of the MID Server in the [ecc_agent_issue] table to Resolved.

Resolving MID Server issues

The error message in the MID Server Issue [ecc_agent_issue] table names the affected MID Server user. This message appears each time the business rule runs and finds a MID Server that is down from suspected bad credentials. MID Server not operational (status: Down), possibly due to recent clone. Verify credentials for logged in User 'local-midserver'.

Attempt to resolve the issue first by comparing the user's credentials with the credentials that the affected MID Server is expecting. If the credentials are incorrect, fix the problem and check the MID Server status again. If the credentials are correct, but the MID Server remains down, check the Knowledge Base for other possible causes.

MID Server resource threshold alerts

The instance displays warnings when a MID Server breaches its resource thresholds for CPU and JVM memory usage, enabling users to create email notifications or custom scripts when a breach occurs.

The MID Server Issue [ecc_agent_issue] table warns users when a MID Server exceeds configured thresholds of its allocated CPU and memory resources. These warnings are published before the MID Server experiences performance degradation or an out-of-memory error, enabling the administrator to increase resources and avoid downtime. Administrators can use a registered event to send email notification to selected recipients, advising them of any threshold breaches, or to create a custom script to do some other type of work. The instance continues to update the MID Server Issue [ecc_agent_issue] table to keep unresolved issues current.

By default, CPU and memory threshold alerts are disabled and no alerts are published to the MID Server Issue [ecc_agent_issue] table. To enable both types of alerting, add these properties to the System Property [sys_properties] table, and then set their values to true:

• mid.threshold.resource.breach.enable.cpu.alerts
• mid.threshold.resource.breach.enable.memory.alerts

For details on adding system properties to the platform, see Add a property using sys_properties.list.

Evaluation process

This processing occurs whether or not alerting is enabled:

1. Every 10 minutes, each MID Server transmits its CPU and memory consumption metrics to the instance. The instance inserts CPU metrics into the Mean CPU used % field of the ECC Agent Scalar Metrics [ecc_agent_scalar_metric] table and memory metrics into the Max memory used % field of the ECC Agent Memory Metrics [ecc_agent_memory_metric] table.
2. After a successful insert, the following business rules run on each table, invoking a script include that calls an appropriate function. Each function takes an average of the metric sets inserted into the tables, based on the configured sampling intervals.

- **Update cpu mean on MID Server Status**: Calls the `MIDResourceThresholdBreach.checkCpuUsage()` script include.
- **Update max memory on MID Server Status**: Calls the `MIDResourceThresholdBreach.checkMemoryUsage` script include.

Each function takes an average of the metric sets inserted into the tables, based on the configured thresholds and sampling intervals. The instance first looks at each MID Server for configuration parameters that set custom threshold values or sampling intervals for that MID Server. If no configuration parameters for these attributes are found, the instance looks in the System Properties [sys_properties] table for custom values to use. If no properties are found, the instance uses the default threshold and interval values from the code.

**Note:** Both the threshold percentages and the sampling intervals are configurable. See Configuring thresholds and sampling intervals for details.

### Alerting process

When alerting for CPU or memory thresholds is enabled, this processing occurs:

1. If the aggregated average metric value equals or exceeds the configured percent threshold, the instance triggers the `mid.threshold.resource.breach` event. Administrators can use this event to create email notifications for threshold breach alerts or to create a custom script.

2. The instance inserts a record of the breach into the MID Server Issue [ecc_agent_issue] table with a **State** value of New and a **Count** of 1, and then publishes a message containing all the pertinent details of the breach. An example of this message is "Mean CPU used % has exceeded threshold (96>=91) for a 40 minute interval span, occurring after start date 2017-01-11 14:25:19. This message appears in the **Short description** field of the MID Server Issue form and in the event. You can copy any part of the message into your email notifications.

### MID Server issue states

When the administrator first examines an issue in the MID Server Issue [ecc_agent_issue] table, the administrator can change the **State** of the issue to Acknowledged to indicate that the issue is being addressed. Each time the instance detects a breach, it attempts to match the breach with an existing issue. If a MID Server already has an issue record for that breach in a **State** of New or Acknowledged, the instance updates the **Last Detected** field with the current date/time and increments the **Count** field in the existing record. This prevents the creation of duplicate records in the MID Server Issue [ecc_agent_issue] table and records the number of times after the initial incident that the breach reoccurred. The administrator can increase MID Server resources gradually and watch the effect on the **Count** field. When the counter stops incrementing, the administrator knows that the MID Server has adequate resources. When the MID Server resource have been adjusted appropriately, the administrator sets the **State** to **Resolved**. If a new threshold breach is logged that matches a MID Server issue with a **State** of **Resolved**, the instance creates a new issue record.

**Note:** Any record in the MID Server Issue [ecc_agent_issue] table that has not been updated in 30 days is deleted, regardless of its state.
Recommendations for resolving resource issues

Administrators have the opportunity to resolve any resource issues with a MID Server when they receive notification of the event. Follow these recommendations for reducing the strain on MID Server resources:

- **JVM memory:**
  - Allocate more max memory to the MID Server. For more information, see Set the MID Server JVM memory size.
  - Add additional MID Servers to share the workload. For more information, see MID Server clusters.
  - Reduce the amount of concurrent processing for the MID Server. This includes segmenting IP Address ranges into smaller segments for a Discovery schedule or loading smaller segments of data within an import job.

- **CPU:** Reduce the activity on the host or migrate the MID Server to a new host with more available resources.

Tables used for resource threshold evaluation

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| MID Server Issue [ecc_agent_issue] | Stores data on various types of MID Server issues, including breaches of configured CPU and memory thresholds. Fields used for resource threshold breaches are:  
  - **count:** Number of times a previously reported threshold breach occurs, if the event is not marked Resolved.  
  - **last_detected:** Current date and time a threshold breach is detected. This field is updated each time a previously detected breach is found, if it is not marked Resolved.  
  - **message:** Descriptive message summarizing the conditions that triggered the threshold breach event. This message includes the actual percentage of CPU and memory calculated and the configured thresholds that were breached.  
  - **mid_server:** Name of the MID Server experiencing the resource threshold breach.  
  - **source:** The issue source for the breach. These are the possible sources:  
    - **CpuMIDResourceThresholdBreach:** CPU threshold issue sources.  
    - **MemoryMIDResourceThresholdBreach:** Memory threshold issue sources. |
### Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server Status [ecc_agent_status]</td>
<td>Stores the percentages used for the CPU and memory resources, averaged over configurable intervals for each resource. The fields used are:</td>
</tr>
<tr>
<td></td>
<td>• Mean CPU used %</td>
</tr>
<tr>
<td></td>
<td>• Max Memory used %</td>
</tr>
<tr>
<td>ECC Agent Scalar Metric [ecc_agent_scalar_metric]</td>
<td>Stores the CPU usage data inserted by each MID Server every 10 minutes. The table field used by resource threshold alerting is <strong>mean</strong>.</td>
</tr>
<tr>
<td>ECC Agent Memory Metric [ecc_agent_memory_metric]</td>
<td>Stores the memory usage data inserted by each MID Server every 10 minutes. The table field used by resource threshold alerting is <strong>max_used_pct</strong>.</td>
</tr>
</tbody>
</table>

### Business rules that check for threshold breaches

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update cpu mean on MID Server Status</td>
<td>Runs after the MID Server inserts a record into the ECC Agent Scalar Metric [ecc_agent_scalar_metric] table. This business rule triggers the MIDResourceThresholdBreach script include function that evaluates threshold settings to determine if the MID Server has breached its configured CPU resource thresholds.</td>
</tr>
<tr>
<td>Update max memory on MID Server Status</td>
<td>Runs after the MID Server inserts a record into the ECC Agent Memory Metric [ecc_agent_memory_metric] table. This business rule triggers the MIDResourceThresholdBreach script include function that evaluates threshold settings to determine if the MID Server has breached its configured memory resource thresholds.</td>
</tr>
</tbody>
</table>

### Configuring thresholds and sampling intervals

You can use the default threshold percentages and sampling intervals or configure custom values using either of these methods:

- **Add system properties** to the instance and change the default values for all MID Servers.
- **Add configuration parameters** to change the default resource values for individual MID Servers.

The system properties and the configuration parameters use the same names.

<table>
<thead>
<tr>
<th>Property/configuration parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mid.threshold.mean_cpu.aggregate_interval_span</td>
<td>Number of 10 minute units in the interval for sampling CPU usage data. The default interval is 30 minutes (3 x 10 min.)</td>
</tr>
<tr>
<td></td>
<td><strong>Default:</strong> 3</td>
</tr>
<tr>
<td>Property/configuration parameter</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| mid.threshold.mean_cpu.percent   | Usage percentage of the total CPU resources that initiates a threshold breach alert.  
**Default:** 95 |
| mid.threshold.mean_max_memory.aggregate_interval_span | Number of 10 minute units in the interval for sampling memory usage data. The default interval is 30 minutes (3 x 10 min.)  
**Default:** 3 |
| mid.threshold.mean_max_memory.percent | Usage percentage of the total memory resources that initiates a threshold breach alert.  
**Default:** 95 |

**MID Server resource reporting**

The **MID Server dashboard** contains two reports that give you views into the consumption of CPU and JVM memory resources. These reports show usage over the previous 30 days.

- **Avg Percentage of CPU Used:** Trending the daily average on CPU usage helps illustrate the amount of CPU processing that the MID Server host consumes. MID Servers deployed on the same host will report the same CPU usage.

- **Avg Percentage of Max Memory Used:** The maximum used percentage (*max_used_pct*) is a useful metric for determining if the MID Server has enough memory resources. This metric is a percentage of the max used memory over the total available memory. Trending this over time provides a visualization of how much memory is needed by the MID Server.

**MID Server user connectivity issues**

The instance writes issues involving MID Server user logins and network connectivity to the MID Server Issue [ecc_agent_issue] table and creates events you can use in custom scripts or to send email notifications.

Records in the MID Server Issue [ecc_agent_issue] table can provide insight into why your MID Server user cannot log in or why a MID Server cannot connect to the instance. The system displays records for connectivity problems in this table that include informative error messages suggesting possible causes. By default, a scheduled job called MIDUserConnectivity runs every four hours and launches the MIDUserConnectivity script include to evaluate MID Server connection activity. Records in the MID Server Issue [ecc_agent_issue] table reflect the status of MID Server login attempts and connectivity at the time the scheduled job runs.

From the perspective of the instance, the MID Server is **Down** when:

- User authentication fails
- User authorization fails.
- Network issues prevent MID Server from establishing a TCP/IP connection.

**Note:** To associate a user with a MID Server, navigate to the `servicenow/<mid_server_name>/agent/config.xml` file and enter the user credentials in the `mid.instance.username` and `mid.instance.password` parameters. Make sure to restart the MID Server to activate your changes.
How issues are logged

User authentication failures and authorization issues are logged automatically to the MID Server agent log file. The message for both is the same: **User cannot be authenticated or is missing the proper roles.** If the issue is related to authorization, the agent.log file shows the list of missing roles.

When debugging is enabled, MID Server issues are logged to the system log (syslog) and are available for display in either a summary or a detailed format. You can also change the sampling interval from the default 4 hours to something shorter for tracking your remediation efforts. For instructions on enabling and configuring debugging for MID Server user issues, see Test remediation efforts for MID Server user connectivity issues.

Data provided

When the instance encounters user connectivity issues, it opens a record in the MID Server Issue [ecc_agent_issue] table.
Example user authentication error message

The MID Server Issue table contains these fields:

### MID Server issue fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last detected</td>
<td>Date and time the issue was last detected.</td>
</tr>
<tr>
<td>Short description</td>
<td>Contents of the generated message that specifies a possible issue with the named user or the MID Server.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Empty in the Jakarta release.</td>
</tr>
<tr>
<td>Issue source</td>
<td>The process that identified the issue. For all issues with MID Server user connectivity, the source is MIDUserConnectivity.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the issue. Possible states are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>New</strong>: Starting state when the instance creates the issue.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Acknowledged</strong>: State set when the administrator first examines the issue.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Resolved</strong>: Ending state, set by the instance, indicating that the issue has been resolved. If the scheduled job does not encounter the issue when it runs again, the instance automatically sets this value.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain associated with the MID Server user account.</td>
</tr>
<tr>
<td>Count</td>
<td>Number of times an issue has been detected. Each time the scheduled job runs and encounters the same issue, it increments this field.</td>
</tr>
</tbody>
</table>

**User authentication failure**

The credentials that the instance uses to authenticate a MID Server user are configured in the MID Server Configuration Parameters [ecc_agent_config] table. If the MID Server user attempts to log into the instance with invalid credentials, the instance rejects the connection, and writes the `login.failed` event to the Events [sysevents] table for the user. Administrators can use this event in a custom script or in email notifications for authentication failure.

⚠️ **Note**: If user authentication fails, user authorization is not attempted.

**User accounts associated with a MID Server**

Either of the following messages in the MID Server Issue [ecc_agent_issue] table indicate authentication failure for user accounts that are associated with a MID Server:

- Login authentication failure for User `<user name>` associated with 1 down MID Server. Check password on MID server.
- Login authentication failure for User `<user name>` associated with `<n>` down MID Servers. Check password on MID servers.

The necessary conditions for these messages to appear are:

- The **Status** field in the MID Servers [ecc_agent] table that is associated with the MID Server indicates that the MID Server is **Down**.
- The user identified in the MID Server Configuration Parameters [ecc_agent_config] table is the user that one or more MID Servers is configured to use for authentication and authorization when connecting to the instance. The record in the [ecc_agent_config] table must have these values:
  - Parameter name [param_name] field set to `mid.instance.username`.
  - Value [value] field set to the user’s name, corresponding to the User ID [user_name] field in Users [sys_user] table.
• The Events [sysevent] table contains posts showing that the last login attempt associated with the user failed during the scheduled time period. The record created in the [sysevent] table contains these field values:
  • Event Name [name] field is set to login.failed.
  • Parm1 [parm1] field is set to the user’s name.

Note: The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).

User accounts with the mid-server role not associated with a MID Server

The following message appears when a user with the mid_server role who is not associated with a MID Server fails to authenticate: Login authentication failure for User <user name> with mid_server role not associated with a MID Server.

The necessary conditions for this message to appear are:
• The User Roles [sys_user_has_role] table contains a record linking the sys_id associated with the user record stored in the [sys_user] table, with the sys_id associated with the mid_server role record stored in the [sys_user_role] table.
• The user is not identified in the MID Server Configuration Parameters [ecc_agent_config] table as the user whom one or more MID Servers are configured to use for authentication and authorization when connecting to the instance.
• The Events [sysevent] table contains posts showing that the last login attempt associated with the user failed during the scheduled time period.
  • The [sysevent] table contains a record with the Event Name [name] field set to login.failed.
  • The Parm1 [parm1] field is set to the user’s name, corresponding to the User ID [user_name] field in Users [sys_user] table.

Note: The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).

User authorization failure

The user authorization check occurs after the MID Server has successfully authenticated on the instance. In this step, the system ensures that the user account associated with a MID Server is granted the minimum roles required. A SOAP web service called MIDServeCheck performs the role checking on the instance. If the MID Server user has the proper roles, the connection is allowed and a login event is written to the Events [sysevents] table. If the user does not have the proper roles, the instance writes a login.authorization.failed event to the Events [sysevents] table. This event provides a comma separated list of the user’s missing roles. Administrators can use this event in custom scripts or in email notifications for authorization failure.

Authorization can fail if a user is missing the mid_server role or any of the important SOAP roles, as in these cases:
• If the user has the soap_script role, the MIDServeCheck SOAP web service runs to check for the appropriate MID Server roles. If the user lacks the mid_server role or any of the other SOAP roles, authorization fails, and the login.authorization.failed event is created.
• If the user is missing the soap_script role, that user is not authorized to launch the MIDServeCheck SOAP web service, which checks for all required MID Server roles. Authorization fails, but the

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**login.authorization.failed** event is not created. When this occurs, the instance displays this message: **Connectivity of MID Server user <user name> cannot be detected by the instance.**

**Users associated with one or more down MID Servers**

Either of the following messages in the MID Server Issue [ecc_agent_issue] table indicate authorization failure for user accounts that are associated with a MID Server that is **Down:**

- **Login authorization failure for User <user name> associated with 1 down MID Server. Re-assign mid_server role to grant all required roles.**
- **Login authorization failure for User <user name> associated with <n> down MID Servers. Re-assign mid_server role to grant all required roles.**

The **MIDUserConnectivity** script include identifies active users associated with one or more down MID Servers whose last login attempt within the reporting period failed user authorization. This message is generated when user authorization failures are detected and reported by the MIDServertCheck scripted web service. However, user authorization failures are not reported for users who are not assigned the soap_script role. Should this occur, problems with the user are reported by the network connectivity message.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

- The user may or may not have the mid_server role.
- The user is identified in the MID Server Configuration Parameters [ecc_agent_config] table as the user whom one or more MID Servers are configured to use for authentication and authorization when connecting to the instance.
- The Events [sysevent] table contains posts showing that the last login attempt associated with the user failed during the scheduled time period. The [sysevent] table contains a record with these settings:
  - Event Name [name] field set to **login.authorization.failed**.
  - Parm1 [parm1] field set to the user’s name, corresponding to the User ID [user_name] field in Users [sys_user] table.

**Note:** The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).

**Users with the proper role not associated with a MID Server**

The following message appears when a user with the mid_server role who is not associated with a MID Server fails authorization: **Login authorization failure for User <user name> with mid_server role not associated with a MID Server.**

This message is generated when user authorization failures are detected in which the user account, with the mid_server role, is not identified as a configured MID Server user in the [ecc_agent_config] table. It is possible that the user account was associated with a MID Server at the time of the failure.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

- The user has the mid_server role. The User Roles [sys_user_has_role] table has a record linking the sys_id associated with the user record stored in the [sys_user] table, with the sys_id associated with the mid_server role record stored in the [sys_user_role] table.
- The user is not identified in the MID Server Configuration Parameters [ecc_agent_config] table as the user whom one or more MID Servers are configured to use for authentication and authorization when connecting to the instance.
The Events [sysevent] table contains posts showing that the last login attempt associated with the user failed during the scheduled time period. The [sysevent] table contains a record with these settings:

- Event Name [name] field set to `login.authorization.failed`.
- Parm1 [parm1] field set to the user’s name, corresponding to the User ID [user_name] field in Users [sys_user] table.

**Note:** The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).

### Network issues

A network issue can prevent the MID Server from connecting to the instance’s TCP/IP server to begin a session. In this case, the instance marks the MID Server as **Down**, because the instance failed to receive the MID Server heartbeat within the prescribed 5 minute interval.

#### Users associated with down MID Servers who have not attempted to log in

Either of the following messages in the MID Server Issue [ecc_agent_issue] table name users associated with MID Servers who have not attempted to log in during the reporting period:

- **User <user name> is associated with 1 down MID Server. No login attempts within reporting period.**
- **User <user name> is associated with <n> down MID Servers. No login attempts within reporting period.**

The MIDUserConnectivity script include reports active users associated with down MID Servers where network connectivity cannot be detected by the instance.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

- The user may or may not have the mid_server role.
- The user is identified in the MID Server Configuration Parameters [ecc_agent_config] table as the user which one or more MID Servers are configured to use for authentication and authorization when connecting to the instance.
- There are no login attempts, either failed or successful, recorded in the Events [sysevent] table for the user during the scheduled reporting period.

**Note:** The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).

#### Users not associated with MID Servers who have not attempted to log in

The following message appears when a user with the mid_server role who is not associated with a MID Server has not attempted to login during the configured reporting interval: **User <user name> with mid_server role is not associated with a MID Server. No login attempts within reporting period.**

The MIDUserConnectivity script include reports active users with the mid_server role not associated with a MID Server, where connectivity cannot be detected by the instance.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

- The user has the mid_server role. The User Roles [sys_user_has_role] table has a record linking the sys_id associated with the user record stored in the [sys_user] table, with the sys_id associated with the mid_server role record stored in the [sys_user_role] table.
• The user is not identified in the MID Server Configuration Parameters [ecc_agent_config] table as the user whom one or more MID Servers are configured to use for authentication and authorization when connecting to the instance.
• There are no login attempts, either failed or successful, recorded in the Events [sysevent] table for the user during the scheduled reporting period.

**Note:** The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).

### Configuration issues

Any of the following messages, discussed above, can indicate a configuration issue:

- **Login authentication failure for User `<user name>` with mid_server role not associated with a MID Server.**
- **Login authorization failure for User `<user name>` with mid_server role not associated with a MID Server.**
- **User `<user name>` with mid_server role is not associated with a MID Server. No login attempts within reporting period.**

These are some common configuration errors:

- An administrator neglected to associate the user record with the MID Server record as shown in the MID Server Configuration Parameters [ecc_agent_config] table. This table is read-only and cannot be updated directly. To associate a user with a MID Server, configure the user name and password in the MID Server's config.xml file and restart the MID Server.
- During the process of reconfiguring a MID Server to use a different account for TCP/IP connection, the administrator has not yet removed the mid_server role from the account or deleted the account.
- A multipurpose user account was created and granted a large number of roles, including the mid_server role, although this account was never intended to be used as a MID Server account.

### User who successfully authenticates and authorizes but might not need mid_server role

The following message appears when a user with the mid_server role who is not associated with a MID Server successfully logs in: **User `<user name>` with mid_server role successfully connected but not associated with a MID Server. The mid_server role should be reserved for MID Server use only.**

The MIDUserConnectivity script include reports active users with the mid_server role who are not identified as a configured MID Server user, and whose last login attempt was successful during the scheduled time period. This message suggests that the user’s credentials are being used by a system administrator or a process that is not running on a MID Server. The assumption here is that the mid_server role should only be used for applications deployed to a MID Server. The presence of this message reminds the system administrator to remove extraneous mid_server roles from user accounts that do not require them.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

- The user has the mid_server role.
- The user is not identified in the MID Server Configuration Parameters [ecc_agent_config] table as the user whom one or more MID Servers are configured to use for authentication and authorization when connecting to the instance.
• The Events [sysevent] table contains posts showing that the last login attempt associated with the user succeeded during the scheduled time period. The [sysevent] table contains a record with these settings:
  • Event Name [name] field set to `login`.
  • Parm1 [parm1] field set to the user’s name, corresponding to the User ID [user_name] field in Users [sys_user] table.

**Note:** The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is empty (=NULL).

**Test remediation efforts for MID Server user connectivity issues**

After attempting to resolve a user connectivity issue that appears in the MID Server Issue [ecc_agent_issue] table, you can test your remediation efforts without having to wait until the next scheduled reporting period by shortening the sampling interval.

Role required: admin

Reconfigure the sampling interval using this procedure and then examine the results in the MID Server Issue [ecc_agent_issue] table. You can set any time span for the sample, but you should define a window of not less than 5 minutes, since this is the default interval of the MID Server heartbeat that reports its status. The recommended method for configuring a shorter sampling interval is to copy and modify the code from the MIDUserConnectivity scheduled job, and then run it manually in the background script utility.

**Caution:** Avoid editing the script in the MIDUserConnectivity schedule record. If you make any change to this record, it will not be updated when you upgrade the instance.

1. Navigate to **System Definition > Scheduled Jobs**.
2. Open the MIDUserConnectivity scheduled job.
3. Copy this line from the Run this script field:
   ```java
   MIDUserConnectivity(0).checkConnectivity(4 * (60 * 60 * 1000));
   ```
   This code sets the 4 hour sampling interval in milliseconds and turns debugging off with the MIDUserConnectivity(0) value.
4. Navigate to **System Definition > Scripts - Background**.
5. Paste the code from the scheduled job into the Run script field.
6. Set the sampling interval to 5 minutes by changing the time calculation to `(5 * 60 * 1000)`.
   The modified command looks like this:
   ```java
   MIDUserConnectivity(0).checkConnectivity (5 * 60 *1000);
   ```
7. Click Run script.
8. Open the record of the MID Server that had the issue and select the **MID Server Issues** related list.
   The issue is updated as follows:
   • If the issue persists, the Count column is incremented, and the Last detected column shows the current date and time.
   • If the issue no longer exists, the system changes the State to Resolved.
Optionally, you can enable debugging by selecting a level, and then run the script again to see the breakdown for each condition evaluated.

Use these settings to select a debugging level:

- For a summary view, enter `MIDUserConnectivity(1)`.
- For a detailed view, enter `MIDUserConnectivity(2)`.

For details about the type of debugging information provided, see Interpretating MID Server user debugging output.

**Interpreting MID Server user debugging output**

Debugging output from the system log is available in either a summary or detailed view for MID Server user issues, but must be enabled manually.

To enable debugging and display all connectivity issues in either of the available formats, you must run a method manually on your instance. For instructions on enabling debugging, see Test remediation efforts for MID Server user connectivity issues. For information about each error condition and how records are created in the MID Server Issue [ecc_agent_issue] table, see MID Server user connectivity issues.

**Available formats**

You can configure the instance to generate a simple summary of the issue or a detailed output that identifies users and MID Servers. Summaries provide a quick look at the issue conditions, by count, while the detailed view allows you to examine roles, MID Server associations, and login activity by named users.

In this summary example of an authorization issue, the instance evaluates each condition and indicates how many users met that condition. You can see that a MID Server is down and that one of two users configured for a MID Server failed authorization. Because this is a summary, neither the MID Server nor the users are named.

```
[0:00:00:014] Script completed in scope global: script

*** Script: Log Object: MIDUserConnectivity: jobSchedulerDateTime
Java Object: com.glide.glideObject.GlideDateTime - 2017-02-21 17:35:08
*** Script: Log Object: MIDUserConnectivity: jobSchedulerDateTime (current users display format and timezone)
Java Object: java.lang.String - 2017-02-21 09:35:08
*** Script: MIDUserConnectivity: found (1) user(s) with the mid_server role defined
*** Script: MIDUserConnectivity: found (1) down MID Servers with a configured 'mid.instance.username' parameter
*** Script: MIDUserConnectivity: found (2) configured MID Server UserIds
*** Script: MIDUserConnectivity: found (0) user(s) with the MID Server role NOT also associated with a configured MID Server user
*** Script: MIDUserConnectivity: found (0) user(s) whose most recent login attempt during the reporting period failed
*** Script: MIDUserConnectivity: found (0) user(s) whose most recent login attempt during the reporting period succeeded
*** Script: MIDUserConnectivity: found (0) configured MID Server users where connectivity to the MID by the instance can not be detected
*** Script: MIDUserConnectivity: processing completed
```

Sample summary debug output
Authentication failure

When a MID Server user cannot authenticate on the instance, the system displays these error messages in the detailed output:

- Login authentication failure for User <user name> associated with 1 down MID Server. Check password on MID server.
- Login authentication failure for User <user name> associated with <n> down MID Servers. Check password on MID servers.
- Login authentication failure for User <user name> with mid_server role not associated with a MID Server.

In this example, three users with the mid_server role, midserver2, local-midserver, and ardis.maison, failed to authenticate. Two of these users were configured for MID Servers that were Down, and the other user was not configured for any MID Servers. Each of these users has an authentication failure and is named in the appropriate error message.
Detailed debugging log for authentication failure.

Authentication issues:
- Users with mid_server role associated with Down MID Servers.
- User accounts with mid_server role, including accounts associated with Down MID Servers.
- User not associated with MID Server.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
MID Server ID map

The debugging output lists all MID Servers that are marked as **Down** and maps them to their user accounts by the MID Server **sys_id**. This map includes all user accounts that have the mid_server role, whether or not they are associated with a MID Server. If there are no **Down** MID Servers, the map is not displayed in the debugging output.

The map is presented in three sections:

- User accounts not associated with any MID Servers.
- User accounts associated with **Down** MID Servers, identified by their **sys_id**.
- The **sys_id** of each **Down** MID Server, identified by name.

**Authorization failure**

If a user is missing any of the required roles, the instance generates these authorization failure messages:

- **Login authorization failure for User <user name> associated with 1 down MID Server. Re-assign mid_server role to grant all required roles.**
- **Login authorization failure for User <user name> associated with <n> down MID Servers. Re-assign mid_server role to grant all required roles.**
- **Login authorization failure for User <user name> with mid_server role not associated with a MID Server.**

In this example, three users with the mid_server role, **midserver2**, **local-midserver**, and **ardis.maison** have failed authorization. One user is not associated with any MID Server, but the other two users are. The system has logged an authorization failure, indicating that the user is missing at least one critical role. To see what roles are missing, look at the comma separated list in the **Parm2** field in the

---

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**login.authorization.failed** event record. This record is the most recent login attempt in the Event [sysevent] table for the user account within the reporting period.
Detailed debugging log for authorization failure

```
*** Script: Log Object: MIDUserConnectivity: activeUserIDsInMalPServerRole
Array of 3 elements
[0]: string = ardis_maison
[1]: string = midserver2
[2]: string = local-midserver

*** Script: Log Object: MIDUserConnectivity: downMIDServerConfiguredUserIDs
Array of 7 elements
[0]: string = midserver2
[1]: string = local-midserver

*** Script: Log Object: MIDUserConnectivity: userInMIDServerMap
Object
  - ardis_maison: Object
    - sys_domain: string = global
      - mid_server: Array of 8 elements
        - midserver2: Object
          - sys_domain: string = global
            - mid_server: Array of 1 element
              - [0]: string = 10x9514353222001b75da3b174a98
        - local-midserver: Object
          - sys_domain: string = global
            - mid_server: Array of 1 element
              - [0]: string = 10x9514353222001b75da3b174a98

*** Script: Log Object: configUserMIDServerUserIDs
Array of 2 elements
[0]: string = midserver2
[1]: string = local-midserver

*** Script: Log Object: MIDUserConnectivity: activeUserIDsInMIDServerRoleNotAssociatedWithConfiguredMIDServer
Array of 1 elements
[0]: string = ardis_maison

*** Script: Log Object: MIDUserConnectivity: userIDsWithIssues
Array of 3 elements
[0]: string = midserver2
[1]: string = local-midserver
[2]: string = ardis_maison

*** Script: Log Object: MIDUserConnectivity: userIDNotMostRecentLoginAttemptFailed
Array of 6 elements

*** Script: Log Object: MIDUserConnectivity: userIDNotMostRecentLoginAttemptAuthorizationFailed
Array of 3 elements
[0]: string = midserver2
[1]: string = local-midserver
[2]: string = ardis_maison

*** Script: Log Object: MIDUserConnectivity: userIDNotMostRecentLoginAttemptSuccessful
Array of 6 elements

*** Script: Log Object: MIDUserConnectivity: userIDsWhereConnectivityToMIDServerCanNotBeDetectedByInstance
Array of 6 elements

*** Script: Log Object: MIDUserConnectivity: doNotAutoReceiveMessages
Array of 3 elements
[0]: string = Login authorization failure for user midserver2 associated with 1 down MIB server. Re-assign mid_server role to grant all required roles.
[1]: string = Login authorization failure for User local-midserver associated with 3 down MIB Servers. Re-assign mid_server role to grant all required roles.
[2]: string = Login authorization failure for user ardis_maison with mid_server role not associated with a MIB server.

*** Script: MIDUserConnectivity: processing completed
```
Network issues

Network issues may exist for these users who are associated with MID Servers, but who have not attempted to log in during the reporting period:

- User `<user name>` is associated with 1 down MID Server. No login attempts within reporting period.
- User `<user name>` is associated with `<n>` down MID Servers. No login attempts within reporting period.

Network issues may also exist for these users who are NOT associated with MID Servers, and who have not attempted to log in during the reporting period: `User `<user name>` with mid_server role is not associated with a MID Server. No login attempts within reporting period.`

In this example, no login attempts have been detected for `midserver2`, `local-midserver`, and `ardis.maison`, all of whom have the mid_server role. Two of those users are associated with MID Servers that are marked Down. The other user is not associated with any MID Server. None of these users has attempted to log in to the system within the configured reporting interval. The system assumes that these users would make an attempt to log in unless network issues prevented them from doing so.

**Note:** By default, the sampling period is 4 hours. However, during debugging or remediation, the sampling period can be reset to a value that matches the MID Server heartbeat interval of 5 minutes, or greater.
Configuration issues

Any of the following messages can indicate a user configuration issue:

- Login authentication failure for User `<user name>` with mid_server role not associated with a MID Server.
- Login authorization failure for User `<user name>` with mid_server role not associated with a MID Server.
- User `<user name>` with mid_server role successfully connected but not associated with a MID Server. The mid-server role should be reserved for MID Server use only.
- User `<user name>` with mid_server role is not associated with a MID Server. No login attempts within reporting period.

In this example, a user with the mid_server role has logged in successfully within the configured sampling interval. However, this user is not configured for a MID Server and might have the role in error.

```
*** Script: Log objects: MIDUserConnectivity, activeUserFromWithMidServerRole
Array of 3 elements
[0]: string = aridix.malcolm
[1]: string = midserver
[2]: string = midserver
*** Script: Log objects: configuredMidServerUserRoleIds
Array of 0 elements
*** Script: Log objects: MIDUserConnectivity, activeUserFromWithMidServerRoleMIDServerNotAssociatedWithConfiguredMidServer
Array of 1 elements
[0]: string = aridix.malcolm
*** Script: Log objects: MIDUserConnectivity, userHasMidServerRole
Array of 1 elements
[0]: string = aridix.malcolm
*** Script: Log objects: MIDUserConnectivity, userHasAuthorizationFailed
Array of 0 elements
*** Script: Log objects: MIDUserConnectivity, userHasAuthenticationFailed
Array of 0 elements
*** Script: Log objects: MIDUserConnectivity, isLoggedInSuccessfully
Array of 1 elements
[0]: string = aridix.malcolm
*** Script: Log objects: MIDUserConnectivity, processesCompleted
Array of 1 elements
[0]: string = user aridix.malcolm with mid_server role successfully connected but is not associated with a MID Server. The mid_server role should be reserved for MID Server use only.
*** Script: MIDUserConnectivity, userHasMidServerRole
```

Detailed debugging log for MID Server user account login
**MID Server Upgrade History**

Use this module to troubleshoot errors that occur during the MID Server upgrade process. The MID Server Upgrade Histories table contains a record of each instance upgrade. The MID Server Upgrade Stages table shows the status of each MID Server and its upgrade progress, including any errors encountered.

**MID Server Upgrade Histories**

Users with admin or agent-admin roles can find detailed information for any MID Server upgrade in the Upgrade History module for MID Server. Whenever an instance is upgraded, all MID Servers in the Up state are upgraded automatically. The Upgrade History module uses the MID Server Upgrade Histories table [ecc_agent_upgrade_history]. This table shows the following information:

- The old instance version.
- The new version.
- The number of successfully upgraded MID Servers.
- The number of MID Servers with pending upgrades. MID Servers have pending upgrades if the upgrade has failed or is in progress.

**MID Server Upgrade Stages**

Select an instance record to see more details about the MID Servers upgraded with that instance. The Pending Upgrades and Complete Upgrade Details related lists use the MID Server Upgrade Stages table [ecc_agent_upgrade_history_stage]. MID Servers pinned to a specific version generate an entry with a blank MID Upgrade History on the MID Server Upgrade Stages table [ecc_agent_upgrade_history_stage].

<table>
<thead>
<tr>
<th>MID Upgrade History</th>
<th>Refers to a corresponding record in the [ecc_agent_upgrade_history] table.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stage</td>
<td>Shows the progress of the MID Server through each stage of the upgrade process.</td>
</tr>
<tr>
<td>State</td>
<td>Shows the status of each stage.</td>
</tr>
<tr>
<td>Message</td>
<td>Displays dynamically generated messages about the upgrade stages, such as the file path to download directories or extract folders. It also displays information about any errors encountered, even if those errors do not block the upgrade.</td>
</tr>
</tbody>
</table>

**MID Server reference information**

MID Server reference information includes system requirements and other information you need to configure a MID Server for your specific needs.
System clones and the MID server

See KB0547597 for information on what to do with MID Servers when you are cloning your instance.

Reference topics

System requirements

Use the minimum system requirements to allocate resources for computers hosting MID Servers.

ECC Queue

Learn about the External Communication Channel (ECC) Queue, which is the connection point between the MID Server and the instance. Jobs that the MID Server needs to perform are saved in this queue until the MID Server is ready to handle them.

MID Server Dashboard

Use the reports and gauges in the MID Server dashboard to monitor ongoing operations.

MID Server properties

Use MID Server properties to control the behavior of all MID Servers or a particular MID Server.

MID Server parameters

Use MID Server parameters to control the behavior of a particular MID Server.

MID Server protected records and reserved characters

Some MID Server records cannot be altered. Certain special characters are pre-defined in XML and cannot be used in passwords.

MID Server privileged commands

To discover certain information on a host server, the MID Server must run SSH commands with higher privileges. The platform provides default privileged commands for the MID Server to use and the ability to add additional commands to the system.

MIDSystem methods
MIDSystem variables (referred to by the variable name ms.) provide a variety of methods to get information about the MID Server.

**MID Server heartbeat**

Configure the interval that the instance uses when it checks the "heartbeat" of MID Server. By default, the instance checks the MID Server for a response every 5 minutes.

**Set JVM memory size**

Modify the JVM setting for your MID Server from the default size to suit the amount of work your MID Server does in your network.

**Pause the MID Server**

Pause the MID Server to temporarily prevent it from polling the ECC Queue for work or sending Discovery results back to the instance.

**MID Server system requirements**

Use these minimum system requirements to allocate resources for computers hosting MID Servers.

**MID Server supported systems**

**Windows server**

To discover Windows-based servers, run Service Mapping patterns, or execute Orchestration commands on Windows devices, the MID Server must be installed on a Windows server. The MID Server supports these Windows operating systems, including virtual machines and 64-bit systems:

- Windows Server 2008
- Windows Server 2012
- Windows Server 2016
- Windows Server 2019

**Note:** .NET Framework version 3.5, 4.0, 4.5, 4.6, or 4.7 is required for Service Mapping support and for Windows pattern-based discovery.
Linux

The MID Server is supported on these Linux versions for virtual machines and 64-bit systems:

- Linux Red Hat 6 and above
- Ubuntu 1404 (Ubuntu 14) and above
- CentOS 6 and above

**Note:** On 64-bit Linux systems, you must install the 32-bit GNU C library *(glibc)*. The installation command for CentOS is: `yum install glibc.i686`.

PowerShell requirements

The MID Server requires the minimum PowerShell version 3.0 and supports versions up to PowerShell 5.1.

**Note:** PowerShell version 2.0 is not supported, therefore it is recommended to upgrade to a higher version. If the MID Server detects that it has version 2.0, it may work partially. The MID Server creates a record in the mid_server issue table with the following message: PowerShell version 2 is deprecated. Upgrading PowerShell to version 5 is recommended.

Java version support

OpenJDK version 1.8.0_231 is bundled with the MID Server installer package and is installed on the host for all new MID Servers. See the HI Knowledge Base article [KB0719830](#) for more information on OpenJDK version support. The installer automatically configures OpenJDK to run in your environment. No additional configuration is required. This version supports both 32-bit and 64-bit MID Servers. For the best performance, install the 64-bit MID Server for your operating system. The MID Server requires a minimum JRE version 1.8.0_161, and recommended version 1.8.0_231. If you are using a lower version than 1.8.0_161, you may see encryption related issues.

**Note:** ServiceNow will discontinue support for 32-bit MID Servers in a future release.

Testing showed that the MID Server works as expected with Oracle Java 11 version 11.0.5 and Oracle JRE 8 version 1.8.0_231. However, Oracle JRE 8 version 1.8.0_231 requires the workaround described in the HI Knowledge Base article [MID Server running Oracle JRE version 8](KB0784442). In order to use Java 11 on Windows MID Servers, refer to [Install Java 11 on Windows MID servers](KB0752451).

Upgraded MID Servers might use different Java versions depending on their release level.

- MID Servers upgraded from Kingston and earlier use the OpenJDK provided with the MID Server installer. This version of the OpenJDK was tested and certified for use with these MID Servers.
- MID Servers upgraded from London continue to use the same JRE you configured for London. The MID Server supports JRE 1.8.

MID Server supports Java 8 and Java 11 on any supported operating system. However, CPU monitoring is disabled by default on Windows with Java 11 because an outdated SIGAR library causes the MID Server to crash. If you decide to patch the SIGAR library, you can re-enable CPU monitoring. See [CPU and maximum memory usage](#) for more information on how to enable CPU monitoring.
Java Service Wrapper

The MID Server installer includes the Tanuki Java Service Wrapper, version 3.5.36.

Setting the JVM Memory size

The MID Server installs with 1 GB of JVM memory. If the suggested memory size for your product is greater than 1 GB, see Set the MID Server JVM memory size for the procedure to override the default setting.

Deployment types

System requirements for your instance are determined by the needs of the individual products you use that require a MID Server.

Standard deployments

The following products are considered "standard" because their MID Servers share the same minimum disk space and memory requirements:

- Discovery
- Event Management
- Integrations
- Orchestration
- Service Mapping

The minimum standard requirements pertain to both a single product and a combined product deployment. You can deploy a single MID Server for multiple standard products without significantly increasing the disk or memory requirements.

High resource deployments

Cloud Management Platform (CMP), alert aggregation and RCA, and Operational Intelligence are processing intensive and require more resources for each MID Server than the standard products. Install MID Servers for these products on dedicated hosts that do not support MID Servers for other products.

Recommended MID Server minimum requirements

All configurations listed here require a quad core processor with a speed of 2 GHz or greater and were calculated for a Windows Server 2012 R2 host.

Note: The MID Server minimum system requirements for 25 concurrent threads includes resource overhead that is independent of the number of threads. As a result, the system requirements for 200 threads do not require a linear increase in resources. You can set the MID Server to use as few as 5 threads without issue. To increase the speed of the MID Server if the host is powerful enough or lightly loaded with other programs, you can increase the threads setting. The threads setting depends on the limitation of the CPU speed, memory, and operating system of the host machine. You might have to experiment to find the optimal threads count that works best when the MID Server is busy so it does not exhaust the host machine’s hardware limitations. This means you may have to refine the thread count to best meet your situation. IMPORTANT: You can set threads.max as high as 200, however, this setting may need to be changed depending on the OS. For example,
Windows-based MID Servers running Discovery uses Powershell which is resource intensive. In this case, you may exhaust the CPU power of the host machine with just 50 threads count.

### MID Server minimum system requirements for 25 concurrent threads (base system)

<table>
<thead>
<tr>
<th>Product</th>
<th>Disk space (GB)</th>
<th>Memory (GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>OS</td>
<td>MID Server + product</td>
</tr>
<tr>
<td>Alert aggregation and RCA</td>
<td>36 GB</td>
<td>10 GB</td>
</tr>
<tr>
<td>Cloud Management Platform (CMP)</td>
<td>36 GB</td>
<td>4 GB</td>
</tr>
<tr>
<td>Operational Intelligence</td>
<td>36 GB</td>
<td>16 GB</td>
</tr>
<tr>
<td>Standard</td>
<td>36 GB</td>
<td>4 GB</td>
</tr>
</tbody>
</table>

### MID Server minimum system requirements for 200 concurrent threads (customer configured)

<table>
<thead>
<tr>
<th>Product</th>
<th>Disk space (GB)</th>
<th>Memory (GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>OS</td>
<td>MID Server + product</td>
</tr>
<tr>
<td>Alert aggregation and RCA</td>
<td>36 GB</td>
<td>10 GB</td>
</tr>
<tr>
<td>Cloud Management Platform (CMP)</td>
<td>36 GB</td>
<td>4 GB</td>
</tr>
<tr>
<td>Operational Intelligence</td>
<td>36 GB</td>
<td>16 GB</td>
</tr>
<tr>
<td>Standard</td>
<td>36 GB</td>
<td>4 GB</td>
</tr>
</tbody>
</table>

**Use case 1: Single MID Server deployed for multiple standard products**

In this example, Service Mapping, Discovery, and Orchestration share a MID Server with 25 threads that is installed on a dedicated host. The disk space and memory requirements specified here satisfy the minimum recommended requirements for the combined product deployment.
One MID Server for multiple standard products

<table>
<thead>
<tr>
<th>Product</th>
<th>Disk space (GB)</th>
<th>Memory (GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>OS</td>
<td>MID Server + product</td>
</tr>
<tr>
<td>Service Mapping + Discovery + Orchestration</td>
<td>36 GB</td>
<td>4 GB</td>
</tr>
</tbody>
</table>

Use case 2: Multiple MID Servers deployed to a single host

In this example, three MID Servers (not clustered) are assigned to different standard products. All three MID Servers are deployed to a single host, where each MID Server has 25 threads. The required resources are calculated as follows:

- **Total disk space required**: Add the recommended disk space for the operating system from the OS column to the sum of the values in the MID Server + product column for all products mapped.
- **Total memory required**: Add the recommended memory for the operating system from the OS memory column to the sum of the values in the JVM memory column for all products mapped.

Calculating resources for multiple MID Servers on a single host

<table>
<thead>
<tr>
<th>Product</th>
<th>Disk space (GB)</th>
<th>Memory (GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>OS</td>
<td>MID Server + product</td>
</tr>
<tr>
<td>MID Server 1</td>
<td>36 GB</td>
<td>4 GB</td>
</tr>
<tr>
<td>MID Server 2</td>
<td>4 GB</td>
<td>1 GB</td>
</tr>
<tr>
<td>MID Server 3</td>
<td>4 GB</td>
<td>1 GB</td>
</tr>
<tr>
<td>Recommended minimum</td>
<td>36 GB</td>
<td>12 GB</td>
</tr>
</tbody>
</table>

Monitoring performance

To ensure that the MID Server resource allocations are sufficient for your environment, monitor performance during peak periods of product execution from the MID Server dashboard.

MID Server supports Java 8 and Java 11 on any supported operating system. However, CPU monitoring is disabled by default on Windows with Java 11 because an outdated SIGAR library causes the MID Server to crash. If you decide to patch the SIGAR library, you can re-enable CPU monitoring. See CPU and maximum memory usage for more information on how to enable CPU monitoring.
MID Server ECC Queue

The External Communication Channel (ECC) Queue is a connection point between an instance and the MID Server. Jobs that the MID Server needs to perform are saved in this queue until the MID Server is ready to handle them.

Asynchronous Message Bus

The MID Server subscribes to messages published by the Asynchronous Message Bus (AMB), which notifies the MID Server that it has pending tasks in the ECC Queue. If a job exists in the ECC Queue for that MID Server, the MID Server sets the status to "I'm working on it." When finished working on a requested job, the MID Server reports back to the ECC queue with the results.

The MID Server opens a persistent connection to the instance through the AMB)Client and listens on the /mid/server/<mid_sys_id> AMB channel. When an output record is inserted into the Queue [ecc_queue] table, an AMB message is sent to the MID Server's channel. The MID Server receives this message and immediately polls the ecc_queue table for work.

The MID Server polls the ECC queue on the regular interval defined in the mid.poll.time configuration parameter, regardless of AMB message activity. The default polling interval is set to 40 seconds, but can be reconfigured. This polling of the ECC queue at a regular interval is done in case the AMB connection is dropped.
MID Server ECC queue polling process

**Note:** The AMB client on the MID Server does not work in all environments and might need to be disabled to avoid performance issues. To disable AMB in your environment, set the `mid.disable_amb` parameter to `true`. When you disable AMB, the MID Server reverts to a default polling interval of 5 seconds, unless the `mid.poll.time` parameter is set to a different value.
ECC Queue information

You can access the ECC Queue by navigating any of these paths:

- Discovery > Output and Artifacts > ECC Queue
- Discovery > Discovery Schedules > {schedule name} > {Discovery status record}
- ECC > Queue
- {Discovery Status record} > ECC Queue

An ECC Queue provides the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>The name of the external system that this messages is either from or to. If the message is from or to a MID Server, the agent name is in the form mid.server.xxx, where xxx is the name of a particular MID Server.</td>
</tr>
<tr>
<td>Topic</td>
<td>The name of the probe the MID server ran. If you are using a pattern for discovery, the #unique_1808Horizontal Pattern probe appears.</td>
</tr>
<tr>
<td>Name</td>
<td>The actual command the probe ran. For example, if Topic is SSHCommand, then the Name field contains the actual shell command to run. If you are using a pattern for discovery, the following appears: Pattern Launcher: followed by the name of the pattern and the multipage number.</td>
</tr>
<tr>
<td>Source</td>
<td>The IP address that the discovery is to run against. A few probes run against multiple IP addresses; in those cases, this field contains a human-readable description.</td>
</tr>
<tr>
<td>Response to</td>
<td>This optional field contains a reference (sys_id) to the ECC Queue message that this message is in response to. Discovery makes extensive use of this field to track the hierarchy of messages that result from a given scheduled Discovery. Click the record icon for the value in this field to open the ECC Queue record for the activity that spawned the current probe or sensor record.</td>
</tr>
<tr>
<td>Queue</td>
<td>An indicator of whether this message was is an input message or an output message.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the current ECC queue record. States update automatically.</td>
</tr>
<tr>
<td>Processed</td>
<td>The time when this message was processed.</td>
</tr>
<tr>
<td>Created</td>
<td>The time when this message was created.</td>
</tr>
<tr>
<td>Sequence</td>
<td>The unique sequence number for this message. This value is automatically generated when an ECC Queue record is inserted. Its use is deprecated.</td>
</tr>
<tr>
<td>Field</td>
<td>Input value</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Error string</td>
<td>An error message, if an error occurred during processing. This field is hidden on the standard form unless there was an error.</td>
</tr>
<tr>
<td>Payload</td>
<td>The body of the message in XML format. The returned XML has a root tag of <code>&lt;results&gt;</code> containing one or more <code>&lt;result&gt;</code> tags and a single <code>&lt;parameters&gt;</code> tag. The parameters are simply an echo of those sent to the MID server in the probe; they vary from probe to probe, but in general they tell the probe the details of what it is to do and how it should behave. The result tags are the most interesting ones: they contain the actual data generated by the probe.</td>
</tr>
</tbody>
</table>

**ECC queue controls**

The ECC Queue form contains these related links:

<table>
<thead>
<tr>
<th>Related link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run again</td>
<td>Runs the probe again. You can re-run probes when you encounter a failed discovery or other unexpected results.</td>
</tr>
<tr>
<td>Go to CMDB item</td>
<td>Open the CI record for the CI that was updated during the discovery.</td>
</tr>
<tr>
<td>Go to Sensor</td>
<td>Open the record for the associated sensor.</td>
</tr>
</tbody>
</table>

**Manage ECC Queue content for a MID Server**

The ECC Queue allows you to create ECC Queue messages, access MID Server log entries, and retrieve statistics from an individual MID Server record.

Role required: admin, mid_server

1. Send remote commands through a MID Server to a hosting device directly from the ECC Queue without running Discovery.
   a) Navigate to the ECC Queue and click **New**.
   b) Create a message with these settings:
      - **Agent**: The name of the MID Server that executes the command.
      - **Topic**: Command
      - **Name**: The actual command that you want to process. For Windows, this is expressed in a DOS command line structure. For Linux, the structure could be a bash command line entry.
      - **Queue**: Output
      - **Payload**: With proper XML tags, you can specify the command here instead of in the **Name** field. The advantage to this is that the command is not restricted by the **Name** field length of 120 characters. Use the following XML format for the command:

```xml
<parameters>
  <parameter name="name" value="ACTUAL_COMMAND_LINE"/>
</parameters>
```
2. Access entries in the ECC Queue that show agent0.log.0 logs and wrapper.log logs for an individual MID Server.
   a) Open a MID Server record.
   b) Under Related Links, click Grab MID Logs.

   ECC queue records appear in the list using the following filter:
   - [Topic] [is] [SystemCommand]
   - [Source] [is] [grabLog]
   - [Agent] [is] [your MID Server]

   Only agent0.log.0 and wrapper.log entries appear. These logs are also accessible in the ~\agent\logs\ file path.
   c) To open a log entry, click the link under the Created column.

3. Access the queue.stats topic for useful information about individual MID Servers, such as memory and CPU usage data.
   a) Open a MID Server record.
   b) Under Related Links, click MID Statistics.

   ECC queue records appear in the list using the following filter:
   - [Topic] [is] [queue.stats]
   - [Agent] [is] [your MID Server]

**MID Server dashboard**

The MID Server dashboard is a central place for MID Server users to monitor ongoing operations. The dashboard consists of reports and gauges that display information from the MID Server Status table.

![MID Server Dashboard](image)

The MID Server Dashboard is available from the MID Server > Dashboard module.
**MID Server status gauge**

The MID Server Status gauge on the dashboard displays basic information about each MID Server. This information comes from the MID Server Status [ecc_agent_status] table.

<table>
<thead>
<tr>
<th>Name</th>
<th>Host name</th>
<th>Status</th>
<th>Validated</th>
<th>Version</th>
<th>Max memory used %</th>
<th>Mean CPU used %</th>
<th>Pending jobs</th>
<th>Processing jobs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid</td>
<td></td>
<td>Passed</td>
<td>Yes</td>
<td>03-08-2015, 09-30-2015</td>
<td>17.17</td>
<td>1.34</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Mid2</td>
<td></td>
<td>Up</td>
<td>Yes</td>
<td>07-10-2015, 09-30-2015</td>
<td>14.06</td>
<td>1.16</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>MidServer3</td>
<td></td>
<td>Down</td>
<td>Yes</td>
<td>01-01-2015, 12-04-2015</td>
<td>29.48</td>
<td>48.27</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Microtrack</td>
<td></td>
<td>Passed</td>
<td></td>
<td>mid.server</td>
<td>58.4</td>
<td>63.3</td>
<td>0</td>
<td>513</td>
</tr>
</tbody>
</table>

**MID Server Dashboard gauge**

If the version is not compatible, the MID Server status is not changed to **Down** in the MID Server dashboard. So it might still appear to be processing commands when it actually is not doing so. You must check the MID Server **Version** on the dashboard.

See KB0535181 for additional MID Server troubleshooting information.

The icons in the **Version** column indicates the following:

- **Red**: Incompatible. The MID Server and instance do not belong to the same release. You must **upgrade the MID Server** and verify that it is not pinned to an older version with the **mid.version.override** property. The MID Server will not be upgraded until the parameter is cleared.

- **Yellow**: Compatible, but an upgrade is recommended. This indicates that the MID Server version belongs to the same family as the instance, but not the same version.

- **Green**: Compatible. No upgrade necessary.

- **Gray**: Incompatible. The instance cannot detect the version.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the MID Server.</td>
</tr>
<tr>
<td>Host name</td>
<td>The name of the system that hosts the MID Server.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the MID Server.</td>
</tr>
<tr>
<td>Validated</td>
<td>Whether or not the MID Server was validated.</td>
</tr>
<tr>
<td>Max memory used %</td>
<td>The highest percent usage of memory on the system that hosts the MID Server, in the configured sampling interval. The default interval is 30 minutes, but this value is user configurable. See MID Server resource threshold alerts for details.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Mean CPU used %</td>
<td>The average percent usage of CPU on the system that hosts the MID Server, in the configured sampling interval. The default interval is 30 minutes, but this value is user configurable. See MID Server resource threshold alerts for details.</td>
</tr>
<tr>
<td>Pending jobs</td>
<td>Number of pending ECC queue jobs for that MID Server.</td>
</tr>
<tr>
<td>Processing jobs</td>
<td>Number of processing ECC queue jobs for that MID Server.</td>
</tr>
<tr>
<td>Version</td>
<td>The version of the MID Server. An icon indicates the validity of the MID Server:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Red</strong>: Incompatible. The MID Server and instance do not belong to the same release. You must upgrade the MID Server and verify that it is not pinned to an older version with the mid.version.override property. The MID Server will not be upgraded until the parameter is cleared.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Yellow</strong>: Compatible, but an upgrade is recommended. This indicates that the MID Server version belongs to the same family as the instance, but not the same version.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Green</strong>: Compatible. No upgrade necessary.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Gray</strong>: Incompatible. The instance cannot detect the version.</td>
</tr>
<tr>
<td>User</td>
<td>The login name of the user. An icon indicates the validity of the user:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Red</strong>: Incompatible. The user does not have the mid_server role or the user does not match the value in the mid.instance.username parameter (in the config.xml configuration file). Reconfigure the MID Server user and verify that it works.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Green</strong>: Compatible. The user has the mid_server role and matches the user in the configuration file.</td>
</tr>
</tbody>
</table>

**Note:** The user can also have any of the SOAP roles that the mid_server role inherits.

---

**CPU and maximum memory usage**

MID Server supports Java 8 and Java 11 on any supported operating system. However, CPU monitoring is disabled by default on Windows with Java 11 because an outdated SIGAR library causes the MID Server to crash. If you decide to patch the SIGAR library, you can re-enable CPU monitoring. To re-enable CPU monitoring, set the MID Server parameter `mid.monitoring.force_sigar_cpu_monitoring` to True. See Add a MID Server parameter for instructions on how to set MID Server parameters.
This graph shows the average percentage of CPU usage on all the systems that host MID Servers in the last 30 days.

This graph shows the average percentage of maximum memory used by all the systems that host MID Servers in the last 30 days.
CPU memory used

**MID Server properties**

Properties control the behavior of all MID Servers or a particular MID Server.
The MID Server properties are in the MID Server Property [ecc_agent_property] table and can be accessed by navigating to **MID Server > Properties**. To set these properties, you must add them, if they are not already present.

**MID Server properties**

**alias_filtering_behavior**

Sets the behavior of Discovery aliases. Behaviors define how strictly the system enforces the use of credential aliases in Discovery schedules.

The choices for behaviors are:

- **strict**: Aliases defined for the credential must match the aliases configured for the probe.
- **loose**: The probe's credential is used if it contains all the aliases specified in the schedule.

- Type: string
- Default value: loose

**com.glide.closure_max_rows_per_table**

Sets the maximum number of rows allowed in a table. This property is not visible by default and must be added.

- Type: integer
- Default value: 200000

**concurrent.dist.download**

Sets the number of concurrent MID Server auto-upgrades permitted by the instance. The default value of this property is 2, which allows the MID Server to use 2 of the 4 semaphores available on the instance for upgrading. If your instance has more than 4 INT semaphores, you can increase the value in this property to allow more concurrent upgrades.

- Type: integer
- Default value: 2
glide.stored_proc.data_type.validation

Stops validation of data types in stored procedure parameters. Use this property if you use Orchestration to run a stored procedure on MySQL, Oracle DB, and MS-SQL databases and you want to avoid performing data type validation. Restart the MID Server service after you change the value of this property.

- Type: true | false
- Default value: false

max_ci_count_per_page

Defines the maximum CI count per page.

- Type: integer (bytes)
- Default value: 500

You can also configure this as a configuration parameter on an individual MID Server.

mid.aws.sts.assume_role.disable_credential_caching

Set this property to true to prevent the caching of temporary AWS credentials for Cloud Discovery.

- Type: true | false
- Default: false

mid.aws.sts.assume_role.credential_ttl_minutes

Set the number of minutes you want to cache temporary AWS credentials for Cloud Discovery.

- Type: integer
- Default: 60

mid.discovery.max_pattern_payload_size

Defines the maximum overall payload size for the payload of results that come from patterns.

- Type: integer (bytes)
- Default value: 300000

You can also configure this as a configuration parameter on an individual MID Server.

mid.discovery.max_payload_size

Specifies the maximum string length of Discovery results that the MID Server sends to the instance. If the Discovery probe results exceed the limit, the MID Server discards them and returns a warning message.

For probes, this applies only to those probes where the Used by Discovery field is true. For patterns, this applies to the Horizontal Pattern probe.

Set the value to any negative number to disable the payload limit and allow payloads of any size to be sent to the instance. For example, -1.

- Type: integer (bytes)
- Default value: 5000000

You can also configure this as a configuration parameter on an individual MID Server.

mid.discovery.multiprobe.skip_others_on_error

Prevents probes in a multi-probe from iterating through available credentials when another member probe has already failed or timed out. If this property is set to false, each probe in the multi-probe attempts to
connect to the target with the same invalid credentials. This condition results in longer probe execution times on the MID Server.

This property is not visible by default and must be added to the sys_properties table to change the value.

- Type: true | false
- Default value: true

**mid.eccq.max_payload_size**

Specifies the maximum string length of a payload that the MID Server sends to the instance. The MID Server verifies the size of the payload before sending it to the instance. If the payload size exceeds the limit, the MID Server discards it and returns an error message in the payload.

- Type: integer (bytes)
- Default value: 20000000

You can also configure this as a configuration parameter on an individual MID Server.

**mid.powershell.target_base_dir**

Specifies the location of the target base folder used for Discovery using WMI. If another network share is mounted on each Window's target, the folder may be changed by updating this property.

- Type: string
- Default value: admin$\temp

**mid.probe.use_legacy_forward_dns**

Enables the legacy DNSNameResolver probe and disables the default DNSNameResolver probe. See Probes used by Orchestration for more information.

- Type: true | false
- Default value: false

**mid.probe.use_legacy_reverse_dns**

Enables the legacy DNS probe and disables the default DNS probe. If you experience problems with the features of the default DNS probe, use this property to disable those features. The default DNS probe's features include being lightweight and faster due to executing in parallel, while the legacy probe is throttled by the MID Server because it executes in serial. The default probe utilizes DNS lookup by the MID Server host OS to make use of the OS maintained DNS cache, while the legacy probe does not. Consequently, after a DNS lookup by the default probe fails in Windows systems, the OS also tries looking up by NETBIOS name.

- Type: true | false
- Default value: false

**mid.process_flow.log_listener.max_size**

Sets the maximum size in bytes of memory available to save log messages for Flow Designer actions running on a MID Server. The MID Server stores up to the limit in memory and discards additional log messages, then sends the messages back to the instance along with the execution plan.

- Type: integer (bytes)
- Default value: 10485760

**mid.property.jdbc_operations**
Tells the JDBCOrchestrationProbe what JDBC operations it is allowed to execute. Edit this property value to allow JDBC Orchestration activities to perform more operations. All operations are comma separated. Select a MID Server in the **MID server** field to define specific operations for that MID Server, or leave the field empty to apply the list of operations to all MID Servers. This property requires the Orchestration plugin.

- **Type:** string
- **Default value:** select,update,insert,delete,show,create,describe,begin,if,end,not,exists

**mid.property.jms.command.allowed_factory_names**

Comma delimited list of Java Messaging Service (JMS) connection factories that the MID Server requires for a custom JMS activity or action. This property requires the Orchestration plugin.

- **Type:** string
- **Default value:** connectionFactory, queueConnectionFactory, topicConnectionFactory

**mid.property.ssh.use_snc**

Enables the use of the SNCSSH client for Discovery and Orchestration. Change this property to **false** to use J2SSH. This property applies to all MID Servers connected to the instance.

- **Type:** true | false
- **Default value:** true

**mid.servicewatch.max_concurrent_connections**

Defines the maximum number of concurrent tasks sent to an individual host by a single MID Server.

- **Type:** integer
- **Default value:** 7

**mid.sa.prefer_powershell**

Enables MID Server to use PowerShell Remoting.

**Note:** It is not recommended to change this property as it is being deprecated.

- **Type:** True | False
- **Default value:** true

**mid.sa.ssh.use_sncssh**

Toggles SSH between non-interactive and interactive modes. True corresponds to non-interactive mode and allows probes to open sessions with the device without waiting for a prompt. False corresponds to interactive mode, which requires interactive sessions with the device for network devices and servers.

- **Type:** True | False
- **Default value:** true

**mid.shazzam.regulator.interval_ms**

Sets the interval, in milliseconds, in which Shazzam can launch packets.

- **Type:** integer
- **Default value:** 1

**mid.shazzam.regulator.packets_per_interval**
Sets the number of packets that Shazzam can launch in the time interval specified by the 
`mid.shazzam.regulator.interval_msec` property.

- Type: integer
- Default value: 1

`mid.sm.discolog.max_log_size`

Limits the length of the log statements in the Horizontal Discovery Log. If the results are truncated, the
Command results reports, "Result is larger than [value] characters and was truncated by the logger."

- Type: integer (characters)
- Default value: 1000

`mid.sm.discolog.max_object_size`

Limits the length of the object in the Horizontal Discovery Log. Objects in the log statement are truncated
to the number of characters set by this property's value. This property only affects the object character
size in the Horizontal Discovery Log. The following message appears if an object is limited by this
property "The max object size reached the maximum limit of [value]. To adjust this use the mid property
`mid.sm.discolog.max_object_size`."

- Type: integer (characters)
- Default value: 1000

`mid.snmp.use_getbulk`

Specifies whether to use GETBULK to receive a large amount of data in batches. This can be used to
globally configure all MID servers.

- Type: true | false
- Default value: true

GETBULK can also be set at the probe level or for an individual MID Server. Settings are listed in the
order of precedence:

- SNMP probe parameter
- MID Server configuration parameter
- MID Server properties

`shazzam.chunk_size`

Maximum number of IP addresses Shazzam will scan in parallel. This property primarily controls
outbound port consumption.

- Type: integer
- Default value: 100

Create a MID Server property

Use a MID Server property to control either the behavior of all MID Servers or a particular MID Server.
Role required: admin

You set MID Server properties to override MID Server parameters. Configure MID Server properties in the
MID Server plugin. Do not configure MID Server properties in the `glide.properties` file that is located in the
properties folder of the agent. The `glide.properties` file gets overwritten during the upgrade process.

1. Navigate to MID Server > Properties.
2. Click **New**.
3. Fill in the fields, as appropriate (see table).

### MID Server properties fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the property name.</td>
</tr>
<tr>
<td>Value</td>
<td>You can enter the value you want the property to have.</td>
</tr>
</tbody>
</table>

**Note:** If you are amending JDBC operations through the `mid.property.jdbc_operations` properties, you can enter verbs like `BEGIN`, `END`, `IF`, or common PL/SQL block statements. This will assist in being able to run `CREATE` or `ALTER` statements. You might have to restart the MID server before running some of the statements.

| MID Server | Leave this field blank to set a MID Server property that affects all MID Servers. To set a MID Server property for a particular MID Server, select the MID Server. |

4. After setting any MID Server properties, restart the MID Server to ensure the properties sync with the instance.

### MID Server parameters

Parameters control the behavior of a particular MID Server and have lower precedence than MID Server properties.

- **Connect**
- **Install**
- **Configure**
- **Encrypt**

To add a parameter to a MID Server, see **Add a MID Server parameter**

**Important:** Changes to parameters only take effect when the MID Server is started (or restarted).
Note: The value of any MID Server parameter in the config.xml file can be encrypted. See Encrypt or decrypt MID Server configuration file values for more information.

Required parameters

Note: Using special characters in an XML configuration file requires you to encode them.

url
Specifies the URL to the associated instance. Normally the URL is similar to https://instance.service-now.com, where you replace instance with the instance name. If you host your own instance, use the URL set by your organization.

- Type: string
- Default value: none

mid_sys_id
Records the MID Server record's unique identifier. This parameter should be empty when you initially configure a MID Server. Do not change the value.

- Type: string
- Default value: automatically set (GUID)

name
Use this parameter to supply a name that is meaningful for you. If you do not supply this parameter, the MID Server uses the default value. A set of business rules synchronizes the name in the configuration file with the name in the MID Server record. The business rules ensure that changing the name in one location also changes the name in the other location.

- Type: string
- Default value: YOUR_MIDSERVER_NAME_GOES_HERE

mid.instance.username or glide.glidesoap.username
If the ServiceNow instance has authentication enabled, as it is by default, set this parameter to define the user name the MID Server should use to log in to the instance. This user should have the mid_server role on the ServiceNow instance in order to access necessary tables and fields. You can use this parameter to define user names with special characters.

- Type: string
- Default value: none

mid.instance.password or glide.glidesoap.password
If your ServiceNow instance has authentication enabled, as it is by default, set this parameter to define the password the MID Server should use to log in to the instance. You can use this parameter to define passwords with special characters.

- Type: string
- Default value: none
CIM parameters

**mid.cim.batch.size**
Specifies the maximum number of messages sent at once to a CIM server.
- Type: integer
- Default value: 1

**mid.cim.request.interval**
Specifies the number of milliseconds to wait between requests to the same Common Information Model Object Manager (CIMOM).
- Type: integer
- Default value: 0

**mid.cim.host.connection.limit**
Specifies the maximum number of simultaneous connections to each CIMOM. A value of zero disables simultaneous connections.
- Type: integer
- Default value: 0

Connection parameters

**glide.mid.fast.responses**
Instructs the MID Server to try sending messages to the instance as soon as they are ready. Normally the MID Servers end messages to the ServiceNow instance serially (that is, one message at a time). Since many probes can be run in parallel, there can be multiple messages transmitted simultaneously to the instance. Setting this parameter to `true` may decrease the time between a probe's completion and its response arriving at the instance. However, the multiple simultaneous messages consume resources, decreasing the overall instance responsiveness. If there are communications problems, this parameter's value can also cause a logjam on the MID Server, as threads normally used for running probes may become consumed for sending messages. Generally, leave this parameter out of your configuration. Setting it to `true` is meaningful only under very special circumstances.
- Type: true | false
- Default value: false

**glide.mid.max.sender.queue.size**
Places an upper limit on how large the queue is allowed to get. The MID Server starts deleting queued messages if this limit is exceeded. When the MID Server generates messages to the ServiceNow instance faster than it can send them, it queues them temporarily on the file system of the MID Server's host. This queue is normally quite small, and is completely emptied as soon as the MID Server processing slows for a short period. However, this queue can grow in size when there are communication problems between the MID Server and the instance, and especially if there is an integration running on the MID Server.

The parameter is of the form `{number}{multiplier}`, where `{number}` is any positive decimal number including non-integers, and the optional multiplier is any spelling of bytes, kilobytes, megabytes, gigabytes, or terabytes (only the first character is tested, and the test is case-insensitive). The default
multiplier is bytes. White space is liberally tolerated. The following strings all represent valid parameters: "1000000000", "0.5m", "5 GB", "7.67gigas", "145.69392 meg", and "1.1 terra".

- Type: string
- Default value: 0.5 GB

instance.date.format
Specifies the format the instance uses for dates and times. The primary impact of setting this parameter is to allow the MID Server to correctly refresh its start and stop times on the MID Server record in ServiceNow. The format of this date/time string is identical to that used by the Java SimpleDateFormat class.

- Type: string (Date format)
- Default value: yyyy-MM-dd HH:mm:ss

mid.disable_amb
Disables the Asynchronous Message Bus (AMB) Client. When AMB is enabled, the MID Server uses a default polling interval of 40 seconds. When the AMB client is disabled, the default polling interval switches to 5 seconds. If you set a polling interval with the mid.poll.time parameter, the MID Server uses that value whether or not the AMB client is enabled.

- Type: true | false
- Default value: false

mid.https.truststore.password
Sets the trustStore password that is required for HTTPS connections with the Asynchronous Message Bus (AMB) Client.

- Type: string
- Default value: none

mid.https.truststore.path
Path to the trustStore to be used by the MID Server for TLS transactions (Asynchronous Message Bus (AMB) Client). Add this parameter only if you want to change the default path.

- Type: string
- Default: Path to the JRE trustStore bundled with the MID Server

mid.jmx.enabled
Enables a JMX server on the MID Server, which exposes some management information to JMX consoles. Implementing JMX requires additional configuration of the Java runtime environment. Setting this parameter to true is only recommended for those with detailed knowledge of the Java security architecture and a specific need for JMX.

- Type: true | false
- Default value: false

mid.poll.time
Sets the default MID Server polling interval (in seconds). The polling interval is the amount of time the MID Server waits before checking the ECC queue for work when the ECC queue is not busy. The MID Server polls the ECC queue using this interval if the AMB client connection is dropped.

- Type: string
- Default value: 0.5 GB
Note: The default polling interval resets to 5 seconds when the AMB client is disabled. If you configure the `mid.poll.time` parameter, the MID Server uses this polling interval whether or not the AMB client is connected.

- Type: integer (seconds)
- Default value: 40

`threads.interactive.max`
Sets the maximum number of interactive worker threads that run simultaneously in the interactive thread pool. See Set MID Server Thread Use.

- Type: integer
- Default value: 10

`threads.expedited.max`
Sets the maximum number of expedited worker threads that can run simultaneously in the expedited thread pool. See Set MID Server Thread Use.

- Type: integer
- Default value: 20

`threads.max`
Sets the maximum number of standard worker threads that can run simultaneously in the standard thread pool. This parameter provides direct control over what CPU resources the MID Server consumes on the computer that hosts it. See Set MID Server Thread Use.

- Type: integer (threads)
- Default value: 25

Important: You can set `threads.max` as high as 200, however, this setting may need to be changed depending on the OS. For example, Windows-based MID Servers running Discovery uses Powershell which is resource intensive. In this case, you may exhaust the CPU power of the host machine with just 50 threads count.

Credentials parameters

`mid.aws.instance_profile_name`
Name of the AWS IAM role configured on the EC2 instance. When configured, the MID Server uses the temporary credentials granted to this role by the AWS instance profile to Discover cloud resources.

- Type: string
- Default value: None (User must provide a non-blank value)

`mid.credentials.provider`
Specifies the Java class name of the credentials provider.

- Type: string
- Default value: com.service_now.mid.creds.standard.StandardCredentialsProvider
mid.secure_credentials.key_pairs.provider

Class that the MID Server uses to generate secure key pairs.

- Type: String
- Default value: com.service_now.mid.keypairs.provider.standard.StandardKeyPairsProvider

Debug parameters

debug.logging

[Deprecated] Specifies whether to enable logging of MID Server events and messages (both sent and received). Normally this parameter is only used by developers, but it is occasionally useful when troubleshooting a problem. Be aware that setting this parameter to true causes intensive logging on the MID Server, potentially using considerable disk space.

- Type: True | False
- Default value: false

This parameter has been replaced by the mid.log.level parameter.

debug

[Deprecated] Specifies whether to enable debug logging on the MID Server. Normally this parameter is only used by developers, but it is occasionally useful when troubleshooting a problem. Be aware that setting this parameter to true causes intensive logging on the MID Server, potentially using considerable disk space.

- Type: True | False
- Default value: false

This parameter has been replaced by the mid.log.level parameter.

file.probe.template.debug

Specifies whether to debug file probe templates.

- Type: True | False
- Default: false

mid.cim.debug

Specifies whether to enable debug logging for CIM, WBEM, SLP, or SMI-S.

- Type: True | False
- Default value: false

mid.ssh.debug

Enables SSH debug information in the log file. The parameter usage depends on whether the ServiceNow SSH client is enabled.

When the ServiceNow SSH client is enabled, the parameter functions as follows:

- Type: String
The following string values are valid for the ServiceNow SSH client:

- **true**: Enables SSH debug information in the log file.
- **false**: Disables SSH debug information in the log file.
- **<IP Addresses>**: Specify which IP ranges to enable SSH debug information in the log file. You can enter IP addresses in the following formats:
  - An IP range defined by a slash and the number of bits in the subnetwork. For example, the string `10.10.10.0/24` scans 24 bits of IP addresses from `10.10.10.0` to `10.10.10.254`.
  - An IP range defined by a dash. For example, the string `10.10.11.0-10.10.11.165` scans the IP addresses from `10.10.11.0` to `10.10.11.165`.
  - A comma-separated list of specific IP addresses. For example the string `10.10.11.200,10.10.11.235` scans the IP addresses `10.10.11.200` and `10.10.11.235`.
- **deferred**: Logs SSH debug information in memory unless an error or warning occurs. If an error or warning occurs, the platform publishes the debug information to the log file. This ensures that only the part of the log file pertaining to the error or warning is recorded. If no error or warning is detected, the platform deletes the unused log data from memory when the session closes. Each session stores up to 1000 log messages. If the session exceeds 1000 log messages, the deferred log discards the oldest log message to make room for the newest log message.

When the ServiceNow SSH client is disabled, the parameter enables or disables SSH debug information in the log file:

- **Type**: True | False
- **Default value**: false

**mid.log.level**

Specifies the logging level for the MID Server. Possible values are:

- **debug**
- **info**
- **warn**
- **error**

**Note**: Values are case insensitive.

- **Type**: String
- **Default value**: info

**mid.http.idle_connection_monitor.debug**

Enables debug logging for the Idle Connection Monitor.

- **Type**: True | False
- **Default value**: false

**DNS parameters**

**mid.dns_scan.regulator.interval_ms**

Specifies the interval between DNS scans in milliseconds.
mid.dns_scan.regulator.packets_per_interval
Specifies the number of regulator packets per DNS scan.
- Type: Integer
- Default value: 10

mid.dns_scan.default_name_servers
Specifies the host names or IP addresses of the default name servers.
- Type: String
- Default value: none

mid.dns_scan.default_name_servers
Specifies the host names or IP addresses of the default name servers.
- Type: String
- Default value: none

mid.dns_scan.additional_name_servers
Specifies the host names or IP addresses of any additional name servers.
- Type: String
- Default value: none

mid.dns_scan.load_balancing_enable
Specifies whether to enable load balancing of name servers.
- Type: True | False
- Default value: false

mid.probe.use_legacy_forward_dns
Enables the legacy DNSNameResolver probe and disables the default DNSNameResolver probe. See Probes used by Orchestration for more information.
- Type: True | False
- Default value: false

mid.probe.use_legacy_reverse_dns
Enables the legacy DNS probe and disables the default DNS probe. If you experience problems with the features of the default DNS probe, use this parameter to disable those features. The default DNS probe's features include being lightweight and faster due to executing in parallel, while the legacy probe is throttled by the MID Server because it executes in serial. The default probe utilizes DNS lookup by the MID Server host OS to make use of the OS maintained DNS cache, while the legacy probe does not. Consequently, after a DNS lookup by the default probe fails in Windows systems, the OS also tries looking up by NETBIOS name.
- Type: True | False
- Default value: false
**Event Management parameters**

**mid.probe.event.bulk_size**
Specifies the maximum size of an event payload, in MB.
- Type: Integer
- Default value: 120

**mid.probe.event.wait_time**
Waiting period on an empty queue for sending events.
- Type: Integer
- Default value: 1000

**mid.probe.event.send.enabled**
Enables or disables the sending of events.
- Type: True | False
- Default value: true

**mid.probe.event.queue.max_size**
Specifies the maximum size permitted for the event queue before incoming events are rejected.
- Type: Integer
- Default value: 100,000

**mid.probe.event.queue.use_bulk**
Specifies whether events are sent to the server singly or in bulk. If this parameter evaluates to true then events are sent to the server in bulk.
- Type: True | False
- Default value: true

**mid.probe.event.max.retry_time**
The maximum number of seconds MID retries sending events.
- Type: integer
- Default: 1800

**mid.probe.event.suppress.whitespaces**
Allows line breaks in description fields for multi-line events. Apply this parameter to each MID Server used with event connector instances. Choices are:

- **all**
  This setting removes all whitespaces.

- **leave_as_is**
  This setting keeps all whitespaces.

- **keep_newline**
This setting keeps only new_line and removes all other whitespaces.

- Type: String
- Default: all

**mid.em.metric.metric_to_ci_map_limit**

Specifies the maximum number of active metrics allowed per CI map.

- Type: String
- Default value: 200,000

**mid.em.metric_binding_timeout_seconds**

Specifies the number of seconds to wait before resending unhandled events.

- Type: Integer
- Default value: 300

**mid.em.metric_binding_timeout_max_seconds**

Specifies the maximum number of seconds to wait before resending unhandled events.

- Type: Integer
- Default value: 10800

**mid.em.metric_max_elapsed_time_before_refresh**

Specifies the maximum number of seconds before the metric source type cache is refreshed in memory.

- Type: Integer
- Default value: 60

**mid.em.metric_max_sql_string_length_for_types**

Specifies the maximum length of the string (composed of types) used for an SQL command.

- Type: Integer
- Default value: 30000

**mid.em.statistics_report_period_sec**

Specifies the period, in seconds, between statistics reports to the instance. Use 0 to disable reporting. This parameter requires a restart.

- Type: Integer
- Default value: 60

**mid.em.metric_connector_max_run_time_seconds**

Specifies the maximum number of seconds to collect metrics in every cycle.

- Type: Integer
- Default value: 300

**mid.em.metric_connector_history_min**

Specifies the number of minutes to go back in history to retrieve metrics.

- Type: Integer
**mid.em.metric_event_logging**
Specifies the level of metric and event logging. Choices are:

- none
- all
- events
- metrics
- metrics:<filter>
- events:<filter>

- Type: String
- Default value: none

**mid.em.metric_connector_late_arrivals_delay**
Specifies the number of seconds to delay when collecting metrics.

- Type: Integer
- Default value: 30

**FTP connection parameters**

**mid.ftp.max_pool_size**
Specifies the maximum size of the FTP Connection Pool, in megabytes.

- Type: Integer
- Default value: 25

**mid.ftp.max_per_target**
Specifies the maximum number of the FTP connections per target.

- Type: Integer
- Default value: 5

**mid.ftp.max_conn_idle_time**
Specifies the maximum amount of time, in milliseconds, that an FTP connection can sit idle in the pool.

- Type: Integer
- Default value: 300000

**mid.filesystem.max.ls**
Specifies the maximum number of files that can be returned in the filesystem list directory command.

- Type: Integer
- Default value: 10000
Logging parameters

disable_monitors
Specifies whether to disable the MID Server from actively checking for monitors on the instance.
- Type: True | False
- Default value: true

mid.show.queries
Instructs the MID Server whether to log details about every query it makes to the ServiceNow instance. Typically this parameter is only used by developers, but it is occasionally useful when troubleshooting a problem. Be aware that setting this parameter to true causes intensive logging on the MID Server, potentially using considerable disk space.
- Type: True | False
- Default value: false

disable.remote.logging
Prevents the MID Server from logging any information to the MID Server log on the instance. Relatively little information is logged on the instance in any case, but setting this parameter to true eliminates all logging to the instance.
- Type: True | False
- Default value: false

disable.status
Prevents the MID Server from sending a status report to the instance every 10 minutes.
- Type: True | False
- Default value: false

Pattern parameters

mid.parsing.max_field_size
Sets the maximum character length of strings stored as temporary variables while patterns are run. Strings longer than this parameter's value are truncated to equal the value. Use the parameter to increase the limit when parsing longer strings.

⚠️ Warning: Exceeding the max field size limits of the SQL database implementation cause errors.
- Type: Integer
- Default value: 1024

Proxy server parameters

mid.instance.use_proxy or mid.proxy.use_proxy
If your MID Server must go through a web proxy to access the ServiceNow instance, set this parameter to true to instruct the MID Server to use the proxy. You must also set the proxy server's host and port, and perhaps the user name and password as well.

- **mid.proxy.host**
  - If your MID Server must go through a web proxy to access the ServiceNow instance, set this parameter to define the proxy's host.
  - Type: String
  - Default value: none

- **mid.proxy.password**
  - If your MID Server must go through a web proxy to access the ServiceNow instance, and your proxy requires a password, set this parameter to define that password.
  - Type: String
  - Default value: none

- **mid.proxy.port**
  - If your MID Server must go through a web proxy to access the ServiceNow instance, set this parameter to define the proxy's port.
  - Type: Integer (0-65535)
  - Default value: 80

- **mid.proxy.username**
  - If the MID Server must go through a web proxy to access the ServiceNow instance, and the proxy requires a user name, set this parameter to define that user name.
  - Type: String
  - Default value: none

### Request timeout override parameters

- **mid.sa.cloud.request_timeout**
  - Sets the timeout in milliseconds for cloud requests. This parameter overrides the `glide.http.timeout` system property, which specifies the maximum number of milliseconds to wait before an outbound REST transaction times out.
  - Type: integer
  - Default value: 30000

- **mid.http_classy.request_timeout**
  - Sets the timeout in milliseconds for HTTP classification requests with the HTTP - Classify probe. This parameter overrides the `glide.http.timeout` system property, which specifies the maximum number of milliseconds to wait before an outbound transaction times out.
  - Type: integer
Shazzam parameters

mid.shazzam.regulator.interval_ms
Sets the interval, in milliseconds, in which Shazzam can launch packets. This parameter works with the mid.shazzam.regulator.packets_per_interval parameter to set the number of packets allowed in this interval. By default, Shazzam launches one packet each millisecond.

- Type: Integer
- Default value: 1

mid.shazzam.regulator.packets_per_interval
Sets the number of packets that Shazzam can launch in the configured time interval. This parameter works with the mid.shazzam.regulator.interval_ms parameter, which sets that interval. By default, Shazzam launches one packet each millisecond.

- Type: Integer
- Default value: 1

mid.shazzam.chunk_size
Specifies the maximum number of IP addresses that Shazzam scans in parallel. This parameter primarily controls outbound port consumption.

- Type: Integer
- Default value: 100

SNMP configuration parameters

mid.snmp.enable_auto_public
Specifies whether to use the SNMP public community string automatically if no other SNMP credentials were successful.

- Type: True | False
- Default value: true

mid.snmp.request.timeout
Specifies the timeout value for the first OID request, in milliseconds. For subsequent requests (for example, table OIDs), the mid.snmp.session.timeout configuration parameter (see below) takes effect.

Note: You can override this parameter with the timeout SNMP probe parameter.

- Type: Integer
- Default value: 1500

mid.snmp.session.timeout
Specifies the timeout value for subsequent OID request, in milliseconds. SNMP communication is
stateless and does not have a session or connection in the normal sense. The system regards a positive
response from the first OID request as a sign that it should expect prompt responses to subsequent
requests. While the default is short, it may be useful to increase this parameter value to the same value
as that used for mid.snmp.request.timeout.

Note: You can override this parameter with the establish_session_timeout SNMP probe
parameter.

- Type: Integer
- Default value: 500

mid.snmp.use_getbulk
Specifications whether to use GETBULK to receive a large amount of data in batches. This can be used to
configure an individual MID Server.
- Type: True | False
- Default value: True

GETBULK can also be set at the probe level or globally for all MID servers. Settings are listed in the order
of precedence:
- SNMP probe parameter
- MID Server configuration parameter
- MID Server properties

mid.snmp.use_snmp4j
Use the Snmp4j library for SNMP communication. This is a strict requirement for SNMPv3. This
parameter should only be set to false based on advice from ServiceNow Technical Support.
- Type: True | False
- Default value: true

mid.snmp.use_snmp_v1_v2c
Use the Snmp4j library for SNMP communication. This is a strict requirement for SNMPv3. This
parameter should only be set to false based on advice from ServiceNow Technical Support.
- Type: True | False
- Default value: true

mid.snmp.use_snmp_v3
Attempt communication using the SNMPv3 protocol version. Requires configuration of SNMPv3
credentials.
- Type: True | False
- Default value: true

SSH Discovery parameters

By default, the MID Server is configured to search for SSH commands in the following paths and the
logged-on user's default paths:
• /usr/sbin
• /usr/bin
• /bin
• /sbin

**mid.connection_cache**
Specifies whether to cache connections. Set to **false** to disable connection caching. This parameter applies to SSH connections only.

- Type: true | false
- Default value: true

**mid.ssh.set_path**
Specifies whether to set the PATH environment variable for SSH commands.

- Type: true | false
- Default value: true

**mid.ssh.local**
Specifies whether to execute commands for the MID Server host machine (localhost) via SSH rather than from a console. This allows long-running commands to execute properly. This parameter applies to the legacy SSH client only.

- Type: true | false
- Default value: false

**mid.ssh_connections_per_host**
Controls the number of concurrent probes the MID Server can run against a given host. Lowering the number of concurrent connections can slow Discovery.

- Type: integer
- Default value:
  - 7 for the ServiceNow client
  - 3 for the legacy SSH client

**mid.ssh.sudo_preserve_environment**
Specifies whether to use sudo to preserve the environment for SSH.

- Type: true | false
- Default value: false

**mid.ssh.path_override**
Overrides the default paths set before executing a command. Enter one or more override paths delimited by a colon (:). The default path is /usr/sbin:/usr/bin:/bin:/sbin.

The ServiceNow SSH client accepts the following prefixes in front of the path_override value.

- **append**: Appends the override path to the end of the host’s path. This is the default behavior.
- **replace**: Replaces the host path with the path_override value.
- **prepend**: Appends the override path to the front of the host path.

- Type: string (a colon-separated list of directories)
- Default value: None

**mid.ssh.use_snc**
Enables the ServiceNow SSH client (SNCSSH) on individual MID Servers. SNCSSH is a ServiceNow implementation of an SSH client and is active by default for all MID Servers on new instances, via a MID Server property. Enabling the ServiceNow SSH client disables the legacy J2SSH client.

**Important:** Mixing SSH client types for MID Servers connected to the same instance is not a good practice.

- Type: true | false
- Default value: false

**mid.ssh.max_retries**
Specifies the maximum amount of times to retry an SSH operation after a time-out. The system sleeps two seconds between each connection attempt. By default, the MID Server retries once only. Set the parameter to 0 to disable retries.

- Type: integer
- Default value: 1

**mid.ssh.alt_rm**
Sets a different SSH remove file command.

- Type: string
- Default value: none

**mid.ssh.initial_delay_ms**
Delays sending any SSH probe commands to a server after connecting to the target for the time specified, in milliseconds. This parameter applies to the legacy SSH client only.

- Type: integer (milliseconds)
- Default value: 0

**mid.ssh.suppress_history**
Suppresses the generation of the SSH history file. This parameter applies to the legacy SSH client only.

- Type: true | false
- Default value: false

**mid.ssh.socket_timeout**
Specifies the timeout value for the SSH socket to prevent issues created by a socket timeout. Some devices, such as systems with embedded controllers like UPSs and PDUs, that have SSH enabled require more time to respond to an authentication request. The default value of 2 minutes ensures such requests do not timeout prematurely.

- Type: integer (milliseconds)
- Default value: 120000 (2 minutes)

**mid.ssh.channel_timeout**
Specifies the amount of time that the MID Server waits for activity on the SSH socket before closing the connection. If there has been no activity on the SSH socket for the specified timeout value, the MID Server closes the connection. Some devices, such as systems with embedded controllers like UPSs and PDUs, that have SSH enabled may require more time to respond to an authentication request.

- Type: integer (milliseconds)
- Default value: 120000 (2 minutes)

**mid.ssh.session_timeout**

Specifies the amount of time that a cached session remains in memory after last use. Excessively small values tend to decrease performance. This parameter applies to the ServiceNow SSH client only.

- Type: integer (milliseconds)
- Default value: 300000 (5 minutes)

**mid.ssh.command_timeout_ms**

The timeout duration, in milliseconds, for the execution of an SSH command.

- Type: integer (milliseconds)
- Default value: 300000 (5 minutes)

**mid.ssh.use_keyboard_interactive**

Uses the keyboard interactive authentication mode in SSH daemons on which it is activated.

- Type: true | false
- Default value: false

**Caution:** An issue exists in Mac OS X Sierra and later with the authentication order of the password and keyboard-interactive modes that can cause Discovery to fail. For details about this issue and the configuration required for proper SSH authentication, see KB0623600.

**mid.ssh.dh_group_length_min**

Specifies the minimum group length in bits used for generating a "shared secret" key in Diffie-Hillman key exchange. The larger the key the more secure the SSH connection is but at the cost of performance.

- Type: integer (bits)
- Default value: 1024

**mid.ssh.dh_group_length_max**

Specifies the maximum group length in bits used for generating a "shared secret" key in Diffie-Hillman key exchange. The larger the key the more secure the SSH connection is but at the cost of performance.

- Type: integer (bits)
- Default value: 2048

**mid.ssh.shells_supported**

Defines the bourne-compatible shells supported by the MID Server. This value is a comma-separated list of supported shells, such as ksh, dsh, bash and sh.

- Type: string
- Default value: ksh,bash,sh
**mid.ssh.discard_lrc_error**
Discard long running command error output, emulating legacy behavior.

- Type: String
- Default value: j2ssh - true, sncssh - false

**mid.ssh.pool_thread_ratio**
Ratio of the SSH session pool capacity to the configured MID Server thread number (threads.max), expressed as a percentage. The number of permitted pool capacity sessions is set in this parameter. Regardless of the value set in this parameter, the system never permits the pool capacity to fall below 25 sessions.

- Type: Integer
- Default value: 150

**mid.ssh.disable_privilege_check**
This parameter has no effect if the target is using a privileged command other than "sudo." For more information, see MID Server privileged commands.

The remainder of this section only applies to targets which run sudo. When this parameter is set to true, the MID Server assumes that the user configured in the credential has the privilege to run the given command using sudo. The MID Server assumes the target user can run any command string following sudo on the target. When this parameter is set to false, the MID Server runs "sudo -l" on the target to verify the command which follows sudo has permission to run on the target. Regardless of this parameter's value, the MID Server always validates that "sudo" by itself can be run on the target.

Some releases do not show this parameter in the MID Configuration Parameters pull down list. In this case, you may optionally add this parameter in MID Properties.

- Type: true | false
- Default value: false

**Upgrade parameters**

**mid.pinned.version**
Name of the version to which this MID Server is pinned.

- Type: string
- Default value: MID buildstamp

**Note:** To see the MID buildstamp for your instance, type `stats.do` in the navigation filter. An example of the buildstamp format is `london-06-27-2018__patch3-10-24-2018_11-11-2018_0542`.

**mid.upgrade.use_proxy**
If your MID Server must go through a web proxy to access the upgrade URL, set this parameter to true to instruct the MID Server to use the proxy. You must also set the proxy server's host and port. If the instance proxy user name and password are set, they are used for the upgrade proxy as well.

- Type: true | false
- Default value: false
**glide.mid.autoupgrade.proxy_host or glide.glidesoap.proxy_host**
If your MID Server must go through a web proxy to access the upgrade URL, define the proxy's host here.
- Type: string (URL)
- Default value: none

**glide.mid.autoupgrade.proxy_port or glide.glidesoap.proxy_port**
If your MID Server must go through a web proxy to access the upgrade URL, define the proxy's port here.
- Type: integer (0-65535)
- Default value: 80

**glide.mid.autoupgrade.proxy_user**
If your MID Server must go through a web proxy to access the upgrade URL, define the proxy's user name here.
- Type: string (URL)
- Default value: none

**glide.mid.autoupgrade.proxy_password**
If your MID Server must go through a web proxy to access the upgrade URL, define the proxy's password here.
- Type: string
- Default value: none

### Windows Discovery parameters

**mid.monitoring.force_sigar_cpu_monitoring**
Enables CPU monitoring on Windows MID Server hosts using Java 11. An outdated SIGAR library causes the MID Server to crash. If you patch the SIGAR library, set this value to True to enable CPU Monitoring for Windows with Java 11.
- Type: True | False
- Default value: false

**mid.powershell_api.session_pool.max_size**
Specifies the maximum number of sessions allowed in the session pool.

**Note:** Setting or changing this parameter requires restarting the MID Server.

- Type: Integer
- Default value: 25

**mid.powershell_api.session_pool.target.max_size**
Specifies the maximum number of sessions allowed in the pool per target host.
Note: Setting or changing this parameter requires restarting the MID Server.

- Type: Integer
- Default value: 2

**`mid.sa.prefer_powershell`**
Enables MID Server to use PowerShell Remoting.
- Type: True | False
- Default value: false

**`mid.powershell_api_winrm.use_ssl`**
Requires the use of SSL certificates for HTTPS connections using WinRM.
- Type: True | False
- Default value: false

**`mid.powershell_api_winrm.additional_pssesion_options`**
Controls advanced options for a PSSession. For more information about advanced PSSession options, see https://docs.microsoft.com/en-us/powershell/module/microsoft.powershell.core/new-pssessionoption?view=powershell-6.

**`mid.powershell_api_winrm.remote_https_port`**
Configures the port for connecting to Windows servers using PowerShell over HTTPS.
- Type: Integer
- Default value: 5986

**`mid.powershell_api_winrm.remote_port`**
Configures the port for connecting to Windows servers using PowerShell over HTTP.
- Type: Integer
- Default value: 5985

**`mid.powershell_api_winrm.skip_ssl_cert_check`**
Skips the SSL certificate check when using WinRM for HTTPS connections.
- Type: True | False
- Default value: false

**`mid.powershell_api_winrm.skip_ssl_cert_check_options`**
Skips specific SSL certificate checks when using WinRM for HTTPS connections. Configure the MID Server to skip checks for certificates from a Certification Authority (CA), from the Common Name (CN) that identifies the host associated with the certificate, and for revoked certificates.
- Type: String
- Default value: -SkipCACheck -SkipCNCheck -SkipRevocationCheck

**`mid.powershell.use_credentials`**
Determines the credentials to use for Discovery with PowerShell. A setting of `true` directs the MID Server to run probes with the Windows credentials from the credentials table. To run probes with the credentials of the user for the MID Server service, set this parameter to `false`.

- Type: true | false
- Default value: true

**mid.use_powershell**

Enables or disables PowerShell for Discovery. Restart the MID Server after changing the value. If PowerShell is not installed or the version installed is less than version 2.0, Discovery reverts to using WMIRunner.

- Type: true | false
- Default value: true, in the Fuji release.
- Default value: false, in releases prior to Fuji.

**mid.powershell.path**

Enables an administrator to point to a specific PowerShell on a MID Server in cases where more than one PowerShell is installed. Supply the path to the folder containing the PowerShell executable, for example, `C:\mypowershell` or `C:\mypowershell\`. ServiceNow automatically appends the string `powershell.exe` to the path. Configure this parameter when both a 32-bit and 64-bit PowerShells are active on the same MID Server, and it becomes necessary to launch the correct PowerShell for the context. 64-bit Windows employs file system redirection and the MID Server runs as a 32-bit application. If trying to specify a path in `%WinDir%\System32`, Windows automatically redirects to `%WinDir%\SysWOW64`. To avoid redirection, specify the path as `%WinDir%\Sysnative`. For example, instead of `C:\WINDOWS\system32\WindowsPowerShell\v1.0\`, specify `C:\WINDOWS\sysnative\WindowsPowerShell\v1.0\`.

**Note:** On a 64-bit version of Windows XP, a Microsoft hotfix may be required to enable this.

To discover applications running on a 64-bit Windows machine, the MID Server must be running on a 64-bit Windows host machine.

- Type: string (path)
- Default value: none

**mid.powershell.enforce_utf8**

Enable this parameter to force commands on a target Windows system to return UTF-8 encoded output. Disabling it allows the target system to use its default encoding. This parameter is only valid when PowerShell is enabled.

Setting this value to false may result in incorrect values in the CMDB when non-ASCII characters are returned by a probe.

- Type: true | false
- Default value: true

**mid.powershell.local_mid_service_credential_fallback**

Enables automatically falling back to MID Server service credentials if all other credentials fail.

- Type: True | False
- Default value: true

**mid.powershell_api.idle_session_timeout**
Specifies the timeout value of idle PowerShell sessions in seconds.

**Note:** Setting or changing this parameter requires restarting the MID Server.

- **Type:** Integer
- **Default value:** 60

### mid.powershell.command.parameter_passing

Enable this parameter to allow passing PowerShell parameters from the command line.

- **Type:** True | False
- **Default value:** false

### mid.powershell.command.script.parameter_passing

Enable this parameter to allow passing PowerShell scripts from the command line.

- **Type:** True | False
- **Default value:** true

### mid.windows.management_protocol

Enables administrators to select the Windows management protocol used for device and process classification. Options include:

- **WMI**
- **WinRM**

- **Type:** String
- **Default value:** WMI

### mid.windows.probe_timeout

Sets the timeout interval for all Windows probes on a specific MID Server. This value is overridden by the values configured for individual probes with the wmi_timeout probe parameter.

- **Type:** Integer
- **Default value:** 300

### Add a MID Server parameter

Use a MID Server parameter to control the behavior of a particular MID Server.

**Role required:** admin

1. Navigate to **MID Server > Servers**.
2. From the list of MID Servers, select a MID Server to configure.
3. Select the **Configuration Parameters** related list.

This shows all the parameters currently in the MID Server's configuration file. If there are any passwords, they are displayed in asterisks for security reasons. See **MID Server parameters** for a list of available parameters.

4. To add parameters, click **New**, and then complete the form.

After the form is submitted, the configuration file for that MID Server is modified to include the new parameter. Changes to existing parameters are reflected in the MID Server configuration file as well.
Changes made to the MID Server configuration file do not take place immediately, but rather the next time the MID Server is restarted. The MID Server form has a related link for restarting the MID Server.

**Note:** ServiceNow prevents you from saving changes, such as modifying or deleting parameters, that would cause the MID Server to lose communications with the instance. For example, you cannot change the url parameter. Any changes to these protected parameters must be made directly in the `config.xml` file for that MID Server.

5. **(Optional) Set parameters in the `config.xml` file.**
   MID Server configuration is controlled by an XML file called `config.xml`. This file is located in the `/agent` directory, in the MID Server installation directory. You can edit this file directly to make any configuration changes to protected parameters. Many configuration changes, such as those that do
not disrupt communication between the MID Server and the ServiceNow instance, may also be made from the instance.

The structure of the `config.xml` file is simply an outer parameters tag and a series of inner parameter tags. Each parameter tag has name and value attributes.

- To change the value of a parameter, edit the value attribute.
- To add a parameter, add another parameter tag with its name and value.
- To delete a parameter, delete the entire parameter tag.

The order of the parameters within the file is not important. Notice the green comment sections in the sample. Use these elements to add useful comments to the configuration file.

**Note:** When configuring the MID Server for use with a proxy server, be sure to remove the comment tags around the proxy sections that you configure.
MID Server protected records and reserved characters

Some MID Server records cannot be altered. Certain special characters are pre-defined in XML and cannot be used in passwords.

- Ensure that the MID Server can connect to elements inside and outside your network
- Download and install the MID Server on a Linux or Windows host
- Configure your MID Server
- Configure MID Server security

MID Server Records that cannot be altered

These records cannot be modified or deleted.

<table>
<thead>
<tr>
<th>Table</th>
<th>Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public Page [sys_public]</td>
<td>InstanceInfo</td>
</tr>
<tr>
<td>Scripted Web Service [sys_web_service]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• InstanceInfo</td>
</tr>
<tr>
<td></td>
<td>• GetMIDInfo</td>
</tr>
<tr>
<td></td>
<td>• MIDAssignedPackages</td>
</tr>
<tr>
<td></td>
<td>• MIDFieldForFileProvider</td>
</tr>
<tr>
<td></td>
<td>• MIDFileSyncSnapshot</td>
</tr>
<tr>
<td></td>
<td>• MIDServeCheck</td>
</tr>
<tr>
<td></td>
<td>• MIDServerFileProvider</td>
</tr>
</tbody>
</table>

Using special characters in an XML file

The XML specification defines five predefined entities that represent special characters, and requires that all XML processors honor them. If these characters are used in a password, you will experience unexpected results.

The following characters represent the five pre-defined entities:
If you use the pre-defined entity characters in an XML file, such as the MID Server configuration file, you need to encode them. To encode pre-defined entities into an XML document:

- replace " with &quot;
- replace & with &amp;
- replace ’ with &apos;
- replace < with &lt;
- replace > with &gt;

For example, to specify the password as test&amp; in the MID Server config.xml file:

```xml
<parameter encrypt="true" name="mid.instance.password" value="test&amp;"/>
```

**MID Server privileged commands**

To discover certain information on a host server, the MID Server must run SSH commands with higher privileges. The platform provides default privileged commands for the MID Server to use and the ability to add additional commands to the system.

An example of information that requires elevated privileges is information about storage disks on a host server, retrieved with the `fdisk -l` command. If your system cannot use `sudo` commands, you must configure the hosts in your network to use one of the other privileged commands. You can configure different privileged commands for different hosts. However, Discovery supports only one privileged command per host.

**Important:** You can edit supported privileged commands, but do not delete them.

For a list of possible SSH commands requiring root privileges, see SSH credentials.
### SSH privileged escalation command requirements

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| **sudo** | • Host must support the `sudo -S -p <password>` command and return the correct list of allowed SSH commands.  
• Credentials provided for Discovery must be able to run the command `sudo -S -p <password> <commands>`. |
| **pbrun** | • Host must support the `pbrun -v` command and return the correct version of PowerBroker.  
• Credentials provided for Discovery must be able to run `pbrun <commands>`.  
• Discovery does not support any other `pbrun` - options, such as a password prompt.  
• The instance must be able to reach the target host via SSH. |
| **pfexec** | • Host must support the `pfexec id -a` command and return the correct ID.  
• Credentials provided for Discovery must be able to run `pfexec <commands>`.  
• Discovery does not support any other `pfexec` - options, such as a password prompt. |
| **dzdo** | • Host must support the `command -v dzdo` command and return the path to dzdo in standard output.  
• Credentials provided for Discovery must be able to run `dzdo <commands>`.  
• Discovery does not support any other `dzdo` - options, but Discovery supports password authentication for dzdo. |

### Long-running commands with sudo

Configure J2SSH and ServiceNow SSH to prevent long running commands using sudo from failing when the MID Server disconnects.

ServiceNow SSH allows probes to run sudo against individual commands or an entire, long-running script. This is also supported for the **pbrun** and **pfexec** privileged commands.

### Sudo for individual commands

You can run sudo against individual commands within a probe, but only if all the following sudoer configurations are performed on the target:

- The `!requiretty` option is required.
- Allow individual commands to be run by the user in the provided credential with `NOPASSWD` configured.
- The target specifies an individual sudo call in the command or referenced scripts. For example, set sudo as "`sudo fdisk -I`" or "`${sudo:fdisk -I}`" rather than "must_sudo" for the entire script.
Running sudo on an entire script

If any of the required sudoer configuration requirements for individual commands is not in place, Discovery applies sudo to the initial and complete probes, and does not execute sudo remotely inside the command. This condition can be forced by setting `must_sudo` on the probe and eliminating any sudo commands within the probe.

This approach prevents long running commands from failing when the probe disconnects, but cannot specify individual commands in the sudoers configuration.

Logging

The logs from ServiceNow SSH sudo activity run against an entire script show cryptic entries, such as `/tmp/.run.aef13123fe124123`, which prevent administrators from controlling permissible commands and knowing the exact command that was run. Sudo run against individual commands produces more detailed log entries, such as `/sbin/fdisk -l`.

Add a new privileged command for use by the MID Server

Add a new privileged command to the Privileged Command `[privileged_command]` table that is available to your MID Servers.

Role required: admin

1. Navigate to MID Server > Privileged Command and click New.
2. Complete these fields:
   - **Command**: The name of the privileged command.
   - **Password Prompt**: The password prompt displayed to the user for this privileged command, or a regular expression that matches this password prompt. If this field is empty, no password is required for this privileged command, and no prompt is displayed. SUDO commands do not require a password prompt.
3. Click Submit.

Configure the MID Server to use specific privileged commands

You can configure the MID Server to use specific commands in a defined order.

Role required: admin

1. Navigate to the list of MID Servers using one of the following paths:
   - MID Server > Servers
   - Discovery > MID Servers
   - Orchestration > MID Servers
2. Select the MID Server you want to configure.
3. Click the menu icon in the header bar and select View > Advanced from the context menu.
4. In the Privileged Command related list, click Edit.
5. Select the command you want this MID Server to use and click Save. The default order of privileged commands is 100, but you can change the order as necessary. The privileged command with the smallest order number is tried first.

List of privileged commands to use for a MID Server

Create a pbrun profile privileged command

You can create a special configuration for the pbrun privileged command that allows it to run as a profile. Role required: discovery_admin, admin

Of all the privileged commands, only the pbrun command can be configured to run as a profile, and only one of these special pbrun configurations can function on a MID Server.

Important: Edit the existing pbrun record for this purpose. The system ignores any additional commands you create for pbrun.

1. Navigate to MID Server > Privileged Command.
2. Select pbrun from the list.
3. In the Privileged Command record, edit the value in the Command field to use the format pbrun -u <profile>.
   For example, you can set pbrun -u admin as a command to run with an admin profile.
4. Click Update.

Return to Configuring MID Servers.
MIDSystem methods

MIDSystem variables (referred to by the variable name ms.) provide a variety of methods to get information about the MID Server.

<table>
<thead>
<tr>
<th>Method summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>log(String message)</td>
<td>Logs the given message with a standard prefix to indicate that the message was generated by JavaScript.</td>
</tr>
<tr>
<td>getConfigParameter(String parameter name)</td>
<td>Returns the value of the named configuration parameter.</td>
</tr>
<tr>
<td>include(String script include)</td>
<td>Include the MID Server script include with the given name into the current context.</td>
</tr>
<tr>
<td>getName()</td>
<td>Returns the name of the MID Server.</td>
</tr>
<tr>
<td>getSysID()</td>
<td>Returns the sys_id of the MID Server.</td>
</tr>
<tr>
<td>toJavaScript(Object)</td>
<td>Converts the given Java object into the equivalent JavaScript object.</td>
</tr>
</tbody>
</table>

This example writes a message to the log:

```javascript
ms.log('Attempting to log in with user: ' + this.getParameter('user'));
```

**MID Server heartbeat**

The instance checks the MID Server for a response every 5 minutes, using a synthetic transaction monitoring system.
Checking for a heartbeat

ServiceNow instances send a synthetic transaction via the Heartbeat probe to every MID Server every 5 minutes. The Heartbeat probe functions exactly as a normal probe does and is sent by writing an output record to the ECC queue. A MID Server retrieves the record when it queries the ECC queue for work. The MID Server processes the probe just as it would any other probe and responds back to the instance. If the instance does not detect a response from a MID Server, the instance marks that MID Server as Down. If the MID Server responds, the instance considers the MID Server to be functioning and communicating properly with the instance.

Note: Make sure that your MID Server can communicate on port 443. See Configure MID Server network connectivity and MID Server system requirements for more information.

System events

When a MID Server transitions from one state to another, one of these events is triggered:

- mid_server.up: The MID Server goes from a status of Down, Paused, or Upgrading to a status of Up.
- mid_server.down: The MID Server goes from a status of Up to a status of Down.
- mid_server.paused: The MID Server is paused.
- mid_server.upgrading: The MID Server is being automatically upgraded because the instance is being upgraded.

You can use these events to send notifications or trigger actions that you specify in scripts.

Scheduled job

To change the trigger interval for the Heartbeat probe, navigate to System Scheduler > Scheduled Jobs > Scheduled Jobs. Open the MID Server Monitor record and edit the interval.
MID Server heartbeat trigger interval

Set the MID Server JVM memory size

The MID Server starts with a default JVM memory allocation, but you can modify this setting in the configuration file.

Role required: admin
In the base ServiceNow system, the MID Server JVM memory is set to 1024 MB, which is configured in the \agent\conf\wrapper-override.conf file in the MID Server installation directory. This setting might not be appropriate for the way your organization uses the MID Server. If you want the MID Server to work harder, allocate more resources to it. If the MID Server is located in a small branch office and runs in an environment where memory allocation is shared between a print server, mail server, or web proxy server, the allocation might have to be reduced.

**Note:** For a complete list of minimum MID Server requirements, see MID Server system requirements.

1. Open the \ServiceNow\<MID Server name>\agent\conf\wrapper-override.conf file in a text editor.  
   For more information about this file, see Installing Multiple MID Servers on a Single System.
2. Locate the following lines in the file:
   ```
   # OPTIONAL: Maximum Java Heap Size (in MB)
   wrapper.java.maxmemory=1024
   ```
3. Edit the memory allocation.
4. Remove the comment tag (#) from the memory allocation parameter.
5. Save the file.
6. Restart the MID Server service.

**Pause the MID Server**

Pause the MID Server to temporarily prevent it from polling the ECC Queue for work or sending Discovery results back to the instance.

Role required: agent_admin
You can only pause validated MID Servers. You might want to pause the MID Server when your network infrastructure is undergoing changes. This prevents applications like Discovery from throwing errors during a particular maintenance window.

A paused MID Server continues processing commands that it had already retrieved before it was paused. When you resume the MID Server, the MID Server starts retrieving new commands to process.

**Note:** Discovery continues to assign jobs to MID Servers that are **Paused**. MID Servers that are **Down** are not assigned jobs.

1. Open the MID Server record.
2. Select a running MID Server that has been validated.
3. On the MID Server form, select **Pause MID** under Related Links.
   The state of the MID Server changes to **Paused**.

4. To resume MID Server processing, select **Resume MID** under Related Links.

**MID Server pause**

The MID server can be put into a **Paused** state to temporarily prevent it from polling the ECC Queue for work or sending Discovery results back to the instance.

Unlike stopping the MID Server from the **Windows** or **Linux** server command line on the MID Server machine, pausing the MID server is something that you can do from the instance. The MID Server pause feature is available starting with the Istanbul release.
**Note:** You can only pause validated MID Servers.

You can still perform these actions when the MID Server is paused:

- Access the MID Server logs and delete log entries.
- View MID server statistics. While the MID Server is in the **Paused** state it stops generating statistics. But you can still view the statistics generated before you paused the MID Server.
- Retrieve the MID Server thread dump.
- Make and save configuration changes and property changes to the server. The changes take effect after the MID Server is resumed.
- Clear the ECC queue.

The MID server heartbeat continues to function while the MID Server is in the **Paused** state. If the MID Server is upgraded while it is in the **Paused** state, the MID Server state automatically changes to **Up** after successful upgrade. It does not return to the **Paused** state.

During MID Server selection, paused MID Servers can still be selected but are prioritized below MID Servers that are not paused.

**Events that occur during MID Server pause**

The vCenter and SNMP event collectors, continue to run and process events when you pause the MID Server. These events are not part of the normal synchronous communication that the MID Server has with the instance that you see in the ECC queue. Events are still relayed to the instance and can even trigger actions on records in the instance, such as a CI update. For example, if vCenter detects that a virtual machine goes down or is deleted, a vCenter event makes a change to the status of the corresponding CI record for that virtual machine.

To prevent these events from being processed, stop the extensions from running. For more information, see:

- Configure and run the vCenter event collector extension
- Configure the SNMP Trap Collector Extension

**Notifications**

Notifications keep users informed of events that concern them. The system can notify users by email, SMS text message, or push notification.

**Explore**

- Upgrade to New York
- Domain separation and Notifications
- Developer training

**Email**

- Basic email setup
- Advanced email setup
- Create an email notification
- Email client configurations
- Inbound email actions
- Email digests

**Push Notifications**

- Push notifications
- Push notification setup with the ServiceNow Classic mobile app
- Push notification setup with a custom push application

**Subscription-based notifications**

- Create notification channels
- Modify notification channels
- Create personal notifications

**Notifications in messaging applications**

- Setup
- Configure message content
- Create a messaging notification

**Troubleshoot and get help**

- Ask or answer questions in the Platform forum
- Search the HI knowledge base for known error articles
Email and SMS notifications

Use email notifications to send selected users email or SMS notifications about specific activities in the system, such as updates to incidents or change requests.

Email notifications allow administrators to specify:

- When to send the notification
- Who receives the notification
- What content is in the notification
- Whether the notification can be delivered in an email digest and if so, the digest content

Additional email notification options are available. Users can subscribe to notifications, and administrators can make some notifications mandatory.

Administrators also have the option of converting existing email notifications to a rich HTML format. This format provides several advantages, including:

- Raw HTML content is converted into a WYSIWYG format.
- The content can be edited in a feature-rich HTML editor.
- Mail scripts are condensed into a single, easy-to-read line that can be reused in multiple email notifications.
- To prevent broken links, items like images and incidents, that are linked with URLs relative to an instance are converted to absolute links. For example, if an incident is linked using a relative URL, the link is converted to an absolute link.

**Note:** The rich HTML format is the default for all new email notifications.

**Note:** Instances cannot send or receive encrypted email messages. The system strips out the body of the encrypted email because it cannot process the encrypted content in plain text or HTML.

An email notification can also send as an SMS notification if the recipient has subscribed to the notification on an SMS channel. The system uses the subject line of the email notification and converts it to an SMS message. If the administrator doesn't want to use the email notification subject for the SMS notification, they can define an alternate SMS message in the email template form or email notification form. For more information, see Create an email notification.

For more information on creating an SMS channel, see Create notification channels.

If you want to change how the instance processes incoming email, see Inbound email actions. See System email log and mailboxes for examples of messages the system displays when notifications or inbound email actions are not processed.

Email setup

All email notifications use the email properties that you define for your instance and the email accounts that you set up. Your email service can also affect the successful transmission of incoming and outgoing email.
Email accounts

Email administrators set up email accounts to allow the system to connect to external mail services such as POP3, SMTP, or IMAP servers. You can use the ServiceNow-provided email accounts or create your own accounts for your own email services.

Email properties

Use Email Properties to configure settings for inbound and outbound email. Email properties apply to all email accounts.

Email service size restrictions

Your email service, whether you are using a standard ServiceNow email configuration or an alternate email configuration, determines the successful transmission of incoming or outgoing emails based on a maximum email size. An email configuration consists of your instance, email server, and email client.

• **Standard email configurations** – For instances that use the standard email configuration, the ServiceNow mail servers cannot send or receive emails larger than approximately 50 MB (before encoding), including the email header, body text, and attachments. Email messages are encoded by an email client, which increases total email message size. The maximum ServiceNow mail server size restriction is 75 MB (after encoding). The maximum email size limit is enforced regardless of any configured attachment size limits.

• **Alternate email configurations** – If your email service uses a company-owned or third-party server, the approximate size restriction of 50 MB (including the email header, body text, and attachments) may still apply. However, your service might support different maximum total file sizes for inbound and outbound emails. Check with the email administrator of your email service to verify email size limits.

For details on how encoding can affect email message size and email transmission, see KB0521772.

Email service availability

Email service is intentionally shut down on instance clones to prevent resending already delivered email. Upgrades no longer require an extended interruption of email service. Instances continue to process email during an upgrade. For a possible explanation for undelivered emails, see the blog post Whitelisting emails sent from the ServiceNow infrastructure by a ServiceNow Technical Support Engineer in the Now Community.

For instructions on creating and sending custom emails when events on the instance occur, see the tasks in Email and SMS notifications.

Instance-to-instance communication via email

Use #unique_803 to communicate between two instances.

Designate untrusted and trusted email domains

Using Instance Security Center, you can monitor the blocked and allowed incoming email metrics for your instance. For more information, see Designate untrusted and trusted email domains.
Basic email setup

All production instances can send and receive email using ServiceNow-provided resources. The instance has an email address of instance@service-now.com.
Network layout for standard email configuration
Basic email services and features

- Mail servers maintained by ServiceNow.
  - Encrypt mail with opportunistic TLS (Transport Layer Security) if supported by your mail servers.
    If your internal mail servers send and receive messages via a TLS-encrypted channel, ServiceNow mail servers support that communication.
  - Provide a dedicated mailbox for your instance.
- Pre-configured email accounts to connect to ServiceNow mail servers.
  - An SMTP account sends email to your primary Mail Exchange (MX) server from your instance email address of instance@service-now.com.
  - A POP3 account receives email sent to your instance email address of instance@service-now.com.
- High availability features from ServiceNow datacenters.
- Spam detection for incoming email.

Administrators who want to use basic email services can do so by enabling the email properties for sending and receiving email.

_Enable basic email_
Enable basic email to use ServiceNow-provided email servers and accounts.

Role required: admin

1. Navigate to **System Properties > Email**.
2. Configure these email properties and click **Save**.

<table>
<thead>
<tr>
<th>Property section</th>
<th>Label</th>
<th>System property</th>
<th>Setting required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outbound Email Configuration</td>
<td>Email sending enabled</td>
<td>glide.email.smtp.active</td>
<td>Yes</td>
</tr>
<tr>
<td>Inbound Email Configuration</td>
<td>Email receiving enabled</td>
<td>glide.email.read.active</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Advanced email setup

With an advanced email setup, you can use your own SMTP server, POP3 server, or both.

Setting up your own email environment can be useful if you want to use existing filtering, retention, or compliance aspects of your internal email architecture. You can set up email in several ways:

- Use your own SMTP server to forward email to ServiceNow servers.
- Use your own SMTP server to send email.
- Use your own POP3 server to receive email.
- Use your own SMTP and POP3 servers to send and receive email.
- Use an OAuth 2.0-enabled SMTP server to send email from a third-party service.
- Use an OAuth 2.0-enabled IMAP server to receive email from a third-party service.

The following procedures assume that you **enabled basic email properties**.

_Enable using your own SMTP server_
Enable using your own SMTP server so that you can leverage the existing filtering, retention, or compliance aspects of your own SMTP server while also using the ServiceNow POP3 server.
• Role required: admin
• Email server required: SMTP
• Basic email properties: enabled

You can combine your own internal email architecture with the ServiceNow email architecture to handle email. The following diagram demonstrates how you would use your own SMTP server alongside the ServiceNow POP3 server.
1. Navigate to **System Mailboxes** > **Administration** > **Email Accounts**.
The system displays the list of available email accounts.

2. Locate the record for **ServiceNow SMTP** and change **Active** to **false**.

3. Click **New**.

4. Create an email account record for your SMTP server where the **Type** is **SMTP**.

5. From **Related Links**, click **Test Connection**.

   If the email account is valid, the system returns a success message.

Configure the SMTP server in your internal email architecture to forward email from the custom email address to the instance email address. Implement a spam filter on the custom email address.
Enable using your own POP3 server
You can use your own POP3 server to store and receive email for the instance.

- Role required: admin
- Email server required: POP3
- Basic email properties: enabled

1. On your POP3 server, create a mailbox for your instance that has a custom email address. For example, create a mailbox for service-desk@company.com.
2. Navigate to System Mailboxes > Administration > Email Accounts.
   The system displays the list of available email accounts.
3. Optional: If you do not want to receive email sent to the instance@service-now.com mailbox, locate the record for ServiceNow POP3 and change Active to false.
   An instance can receive email from multiple POP3 accounts at the same time. Leaving the ServiceNow POP3 account active allows the instance to receive email sent to the instance default email address.

4. Click New.
   The system displays a blank Email Account form.
5. Create an email account record for your POP3 server where the Type is POP3.
6. From **Related Links**, click **Test Connection**.

If the email account is valid, the system returns a success message.

Connection Test

Connection Successful

Close
Receiving email using your own POP3 server

ServiceNow Instance

Outbox with Email To:
user@yourdomain.com

Inbox For:
helpdesk@yourdomain.com

Send

ServiceNow Outbound Mail Server
relay
Sends Email To:
user@yourdomain.com

Receive

Domain Name System (DNS)
Lookup Mail Server For:
yourdomain.com
mx.yourdomain.com

Your Incoming Mail Server
pop.yourdomain.com
Route To Mailbox For:
user@yourdomain.com

Your Outbound Mail Server
smtp.yourdomain.com
Send Email To:
helpdesk@yourdomain.com

Stop

No

Email Passes Your Spam Filter?

Yes

Receive

Inbox For:
user@yourdomain.com

User Email Account

Outbox with Email To:
helpdesk@yourdomain.com

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Enable using your own SMTP and POP3 servers
You can use your own SMTP and POP3 servers to send email from the instance and to store and receive email for the instance.

- Role required: admin
- Email servers required:
  - SMTP
  - POP3

- Basic email properties: enabled

1. On your POP3 server, create a mailbox for your instance. For example, create a mailbox for service-desk@company.com.
2. Navigate to System Mailboxes > Administration > Email Accounts. The system displays the list of available email accounts.
3. Locate the record for ServiceNow SMTP and change Active to false.
4. Optional: If you do not want to receive email sent to the instance@service-now.com mailbox, locate the record for **ServiceNow POP3** and change **Active** to **false**.

   An instance can receive email from multiple POP3 accounts at the same time. Leaving the **ServiceNow POP3** account active means that the instance receives email sent to its default email address.

5. **Click New**.
   
   The system displays a blank Email Account form.

6. Create an email account record for your SMTP server where the **Type** is **SMTP**.
7. From Related Links, click Test Connection. If the email account is valid, the system returns a success message.

8. Click New. The system displays a blank Email Account form.

9. Create an email account record for your POP3 server where the Type is POP3.

10. From Related Links, click Test Connection. If the email account is valid, the system returns a success message.
Using your own SMTP and POP3 servers

Outbox with Email To: user@yourdomain.com

Inbox For: helpdesk@yourdomain.com

Send

Receive

Domain Name System (DNS)

Lookup Mail Server For:
yourdomain.com

mx.yourdomain.com

Your Outbound Mail Server

smtp.yourdomain.com

Send Email To:
user@yourdomain.com

Your Incoming Mail Server

pop.yourdomain.com

Route To Mailbox For:
user@yourdomain.com

Your Incoming Mail Server

pop.yourdomain.com

Route To Mailbox For:
helpdesk@yourdomain.com

Your Outbound Mail Server

smtp.yourdomain.com

Send Email To:
helpdesk@yourdomain.com

Email Passes Your Spam Filter?

Yes

No

Stop

Inbox For:
user@yourdomain.com

User Email Account

Outbox with Email To:
helpdesk@yourdomain.com
**OAuth email authentication**

OAuth enables your instance to receive and send email through a third-party email account.

Open Authentication (OAuth) is an open standard for authorization that provides administrators with an authorization method when connecting to incoming IMAP and outgoing SMTP servers. OAuth enables an instance to receive and send email from a third-party account, such as Gmail, without having to enter the credentials for that account.

The OAuth 2.0 implementation requires you to obtain an access and refresh token from your third-party email provider for each third-party email account. The tokens are automatically saved to the instance database. They provide authorization for all email communication between the instance and the authorized third-party account. A scheduled job regularly checks to see if email access tokens are valid. If the access token is not valid, but the refresh token is, the instance automatically regenerates a new access token.

OAuth 2.0 support is available starting with the Geneva release. The OAuth implementation supports IMAP and SMTP accounts only. POP3 is not supported. OAuth 1.0 is no longer supported.

**Note:** Customer email accounts configured to use OAuth 1.0 authentication with Gmail cease to function as of April 20, 2015. See KB0546976 for more information.

Activating the Email - OAuth support for IMAP and SMTP plugin allows you to use OAuth with email. If you upgrade to Geneva or later instances and are already using OAuth 1.0, activate the plugin again.

See `#unique_1846` for an example of using an OAuth 2.0 profile to authenticate an outbound REST message with Google to retrieve contact information. Also see `#unique_1847` for more information on OAuth 2.0 support in the instance.

### Activate the OAuth email authentication plugin

OAuth email authentication requires the Email - OAuth support for IMAP and SMTP plugin.

**Role required:** admin

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

### Enable OAuth 2.0 for email

Setting up OAuth 2.0 for email requires you to obtain access and refresh tokens from your email provider.

- **Role required:** admin
- **Plugin required:** Email - OAuth support for IMAP and SMTP

1. Log in to your third-party email account, such as Gmail, and enable OAuth 2.0.
2. Obtain the following from your third-party email account:
   - client ID
   - client secret
   - authorization URL
   - token URL
   - redirect URL
   - token revocation URL

3. Navigate to System OAuth > Application Registry.
4. Click New.
5. Click Connect to a third party OAuth Provider to create an application registry record that email uses.
6. Use the information you obtained from your third-party email account to fill in the fields on the form. See #unique_1850 for instructions. Create the OAuth application registry record and its associated OAuth Entity Profile and OAuth Entity Scope records.
7. Click Submit.
8. Navigate to System Mailboxes > Administration > Email Accounts.
   The system displays the list of available email accounts.
9. Optional: If you do not want to receive email sent to the default instance email address, locate the record for ServiceNow POP3 and change Active to false.
   The system can receive email from multiple POP3 and IMAP email accounts.
10. Locate the records for ServiceNow SMTP and change Active to false.

11. Click New.
    The system displays a blank Email Account form.
12. Create an email account record for your OAuth 2.0 SMTP server where the Type is SMTP.
13. For Authentication, select OAuth 2.0.
14. For OAuth Profile, select the application registry record you created.
15. Click **Authorize Email Account Access** to obtain the access and refresh tokens.

   Another browser window opens asking you to authorize the account access on the third-party email account.

16. Authorize the access.

   After the authorization is successful and the tokens are saved to the instance, the **Authorize Email Account Access** button no longer appears on the Email Account form.

17. Click **New**.

   The system displays a blank Email Account form.

18. Create an email account record for your OAuth 2.0 IMAP server where the **Type** is **IMAP**.

   Use the same **Authentication** and **OAuth profile** settings as the OAuth SMTP email account.

---

### Email accounts

Email accounts store the connection details and credentials the system uses to access external email servers and services.

By default, instances come with email accounts for ServiceNow-managed SMTP and POP3 servers to send and receive email. These accounts cannot be modified, but can be deactivated if you do not want to use them. To connect to other email servers and services you must create email accounts for them. You can create email accounts for servers and services that use these protocols:

- SMTP
- POP3
- IMAP

**Note:** The system only allows one SMTP email account to be active at a time and sends all email through this account. You can however receive email from multiple POP3 or IMAP accounts.

The system stores individual email accounts in the **sys_email_account** table. Create separate email accounts to send and receive email. Use **email properties** to define how the system processes email for all email accounts.

By default, the ServiceNow POP3 server provides each instance with its own mailbox at the address instance@service-now.com. Likewise, the ServiceNow SMTP server sends email from the address instance@service-now.com. To create another mailbox, provision your own POP3 or IMAP server and create an email account to the server on the instance. To change the sent from email address, update the address in the email account you use for sending email.

Emails received via a POP3 or IMAP server account are stored in the Email [sys_email] table and then deleted from the account.
A ServiceNow configured email account

Configure an email account
You can create email accounts in addition to the accounts provisioned for you.

- Role required: admin
- Email server: a compatible email server
  - SMTP
  - POP3
  - IMAP
Warning: An SMTP server that uses a localhost or loopback (127.0.0.1) IP address is not accepted as a compatible email server. For more information, see KB0724199.

1. Navigate to System Mailboxes > Administration > Email Accounts.
2. Click New.
3. Fill in the fields on the form (see table).

### Email Account fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name to identify this Email Account.</td>
</tr>
</tbody>
</table>
| Type             | The type of mail server. The choices are:  
  - Email Reader  
  - POP3  
  - IMAP  
  - Email Sender  
  - SMTP (only one active account permitted) |
<p>| Authentication    | The type of authentication used for the email account to connect to the email server. The choices are Password, OAUTH, and OAUTH 2.0. The Email - OAuth support for IMAP and SMTP plugin must be active for the OAuth options to be visible. |
| OAuth Provider    | Select the OAuth application registry record for this account. This field appears if you selected OAuth 2.0. |
| Server           | The remote server to which this account connects. To activate a server for an on-premise installation, enter the full address (FQDN) of the node (for example, node.customerdomain). |
| Active           | Determines if this Email Account is active. |
| ServiceNow Configured | Indicates if this account is provisioned by ServiceNow. This field is read-only. If you create an account, this option is not selected. |
| Email user label | A display value used for outgoing messages. This field is for SMTP type accounts only. |
| User name        | The user name or ID to authenticate an email address. The value in this field is also the From address when the instance sends email. If you are using SMTP, this must be a full email address. The value in the From field can override this (for SMTP accounts). Note: The address in the From field on the Notification form takes precedence over this field. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>The password when the Authentication type is Password.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You may need to increase the size of this field to accommodate longer passwords. By default, this field has a size of 40 characters.</td>
</tr>
<tr>
<td>From</td>
<td>(SMTP only) The From address used for notifications sent with this account. This address takes precedence over the User name field. If nothing is present in this field, the User name is used as the return address for notifications sent from the instance.</td>
</tr>
<tr>
<td>Connection Security</td>
<td>The type of secure connection. Choose a setting:</td>
</tr>
<tr>
<td></td>
<td>• None: No secure protocol is used.</td>
</tr>
<tr>
<td></td>
<td>• STARTTLS: Upgrades an insecure connection to a secure connection using the SSL/TLS encryption protocol, if your email server supports TLS.</td>
</tr>
<tr>
<td></td>
<td>• SSL/TLS: Connect to an SSL/TLS encrypted port to secure the connection. Email is encrypted between the ServiceNow instance and your mail server.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning:</strong> Selecting a less secure protocol like STARTTLS or None may expose your data. To better ensure the security of data in your email server, select SSL/TLS.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Port</td>
<td>Connection TCP port.</td>
</tr>
</tbody>
</table>

4. **Click Submit.**
5. Click the test connection link at the bottom to test the SMTP, POP3, or IMAP account.

The system displays a pop-up window with the results of the connection test.

If the test succeeds, click **Close** to return to the email account record. If the test fails, click **View Logs** to display more information about the test results.

The system uses the email account to send or receive email.

Enable the system to send or receive email.

**Multiple email readers**
Organize POP3/IMAP email accounts into email account groups (subsets of email accounts) that can be processed by multiple email reader jobs. To improve the performance of inbound email account processing, you can incrementally add email account groups and if needed, email reader jobs to process email account groups concurrently.

**How email account group processing works**

By default, the email reader job processes POP3/IMAP email accounts serially, which can result in longer processing times when you have many email accounts. It can also be difficult to identify any problematic email accounts that might contribute to slower processing times.

To reduce email account processing time, you can create one or more email account groups that contain subsets of your email accounts. Organizing your email accounts into groups enables the default email reader job to process each email account group separately. After creating one or more email account groups, you can then add another email reader job to process account groups concurrently.

Use the `glide.email.inbound.account_group_processing` system property to activate email account group processing.

During email account group processing:

- The system stores the email accounts in the Email Account Groups [sys_email_account_group] table.
• The default email reader job runs every two minutes. The email reader chooses the account group to be processed based on the account group processing state and the date and time that the group was last processed.

• Claimed state: If an account group has a claimed state, the email reader is processing the account group. If you defined other email reader jobs, no other email reader job can claim the group for processing.

• Unclaimed state: If an account group is unclaimed, the account group is available for processing by the email reader.

• The email reader job processes the email accounts contained in the selected account group.

• The email reader job chooses the next available account group for processing and continues processing that account group.

You can monitor the processing of each email account group by using the Email Account Groups [[sys_email_account_group]] table. Each account group record includes the processing duration (how long it takes for the email reader to process all the accounts in the group).

After you review the processing times for your email account groups, determine whether to make further adjustments in email account group processing. For example, you can create another email account group or create another email reader job to process your email account groups in parallel. You define additional email reader jobs using the Schedule [sys_trigger] table.

Set up email account group processing

To set up email account group processing, you must have the email_account_admin or admin role.

1. Create email account groups.

Define one or more email account groups that contain a subset of your POP3/IMAP email accounts. Your base system includes a default email account group. Any POP3/IMAP accounts not contained in an email account group are processed as part of the default email account group.

2. Enable email account group processing

Navigate to sys_properties.list and locate the glide.email.inbound.account_group_processing system property. Set the Value to true. The email reader job starts processing the email account groups that you created.

3. Monitor email account group processing.

Check the status of your email account groups to see if processing time has been reduced. Determine whether the additional groups sufficiently reduce account processing time or consider adding another email reader job to further reduce processing time.

4. Create an email reader job.

As part of fine-tuning email account group processing, create an email reader job to process email account groups concurrently, in addition to the default email reader job.

Create email account groups

Define an email account group that contains a subset of your POP3/IMAP email accounts. The email reader job automatically processes each email account group as scheduled.

Role required: admin or email_account_admin

1. Navigate to System Mailboxes > Administration > Email Account Groups and click New.
2. Fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the account group.</td>
</tr>
<tr>
<td>Email Accounts</td>
<td>A subset of POP3/IMAP email accounts. Select the email accounts that make up the group.</td>
</tr>
<tr>
<td>Note:</td>
<td>When you add an email account to a group, it cannot be reused in other account groups.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that enables the email account group for processing. New account groups are active by default.</td>
</tr>
<tr>
<td>Default</td>
<td>Read only. Check box that indicates the account is the default email account.</td>
</tr>
<tr>
<td>Status</td>
<td>Read only. Processing state of the email account group: Unclaimed or Claimed.</td>
</tr>
<tr>
<td>Claimed by</td>
<td>Read only. ID of the email reader job currently in progress.</td>
</tr>
<tr>
<td>Last Processed</td>
<td>Read only. The last time that the email reader job processed this group.</td>
</tr>
<tr>
<td>Processing Duration</td>
<td>Read only. The length of time taken by an email reader job to process the account group.</td>
</tr>
</tbody>
</table>

3. Click **Create**.

The system updates the Email Account Group [sys_email_account_group] table with the new account group. Use the this table to monitor email account group processing.

- Review email account group processing.
- Determine if you want to continue fine-tuning email account processing. You could add another email account group or another email reader job to process email account groups concurrently.

Enable email account group processing

Enable the email reader job to start processing your email account groups so that you can reduce the time it takes to process inbound email accounts.

Create email account groups.

Role required: admin

1. In the Navigation filter, enter `sys_properties.list`.

   The entire list of properties in the System Properties [sys_properties] table appears.

2. On the list, find and open the `glide.email.inbound.account_group_processing` system property.

3. On the form, set the **Value** to **true**.

4. Click **Update**.

Check the status of your email account groups to see if processing time has been reduced. For more information, see **Monitor email account groups**.

To further reduce processing time, consider creating another email reader job to process inbound email accounts. For more information, see **Create an email reader job**.

Monitor email account groups
Use the Email Account Groups [sys_email_account] table to check the status of email account groups processed by email reader jobs.

1. **Create email account groups.**
2. **Enable email account group processing.**

**Role required:** email_account_admin or admin

1. **Navigate to** **System Mailboxes > Administration > Email Account Groups.**
2. **Review the processing details for each account group:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the email account group.</td>
</tr>
<tr>
<td>Active</td>
<td>The operational state of the email account group. The value true indicates that the account is enabled for email account processing.</td>
</tr>
<tr>
<td>Claimed by</td>
<td>The ID of the email reader job if the job is running on the account group.</td>
</tr>
<tr>
<td>Default</td>
<td>The default indicator. The value true indicates that the email account group is the default.</td>
</tr>
<tr>
<td>Email Accounts</td>
<td>The names of the email accounts contained in the email account group.</td>
</tr>
<tr>
<td>Last Processed</td>
<td>The day and time that the email reader job last processed this account group.</td>
</tr>
<tr>
<td>Processing Duration</td>
<td>The length of time (in hours, minutes, seconds) to process the account group.</td>
</tr>
<tr>
<td>Status</td>
<td>Processing state of the email account group:</td>
</tr>
<tr>
<td></td>
<td>• Unclaimed: The account group is available for processing by the next email reader job.</td>
</tr>
<tr>
<td></td>
<td>• Claimed: An email reader job is processing the current account group.</td>
</tr>
</tbody>
</table>
Email account group — unclaimed processing state

Email account group — claimed processing state

If fine-tuning email accounts, consider doing one of the following:

• Create another email account group.
• Create another email reader job to process email account groups concurrently.

Create an email reader job

If you created email account groups to fine-tune inbound email account processing, you can create an email reader job to process those account groups concurrently, in addition to the default email reader job.

1. Create email account groups.
2. Enable email account group processing
Role required: email_account_admin or admin

1. In the Navigation filter, type `sys_trigger.list`.
2. In the `sys_trigger` table, select the Email Reader job record.
3. In the Email Reader job form:
   a. Enter a unique name for the email reader job to be added so that you can differentiate it from the default email reader job.
   b. If needed, change the time interval for this email reader job.

4. From the form context menu, click **Insert**. Another email reader job is created. This job runs concurrently with the default email reader job to process email account groups.

   **Monitor email account group processing** and determine if the additional reader job reduces processing time. If needed, you can continue fine-tuning email account processing. For example, you might consider adding another email account group.

**Email properties**

The Email Properties page is where you can configure settings for inbound and outbound email.

Email properties are available from either of these modules:

- **System Mailboxes > Email Properties**
- **System Properties > Email Properties**
### Outbound Email Configuration

- **Email sending enabled**: (Yes)
  - Send all email to this test email address (non-production testing): (Yes)

- **Append timestamp to dates and times in sent email**: (Yes)

- **Create visible watermark in sent email. If false, create invisible watermark via hidden div tag**: (Yes)

- **Resend email if server returns these SMTP error codes**: 421, 450, 451, 452

- **Do not resend email if server returns these SMTP error codes**: 500, 501, 502, 503, 504

- **Resend email when server returns unknown SMTP error codes**: (Yes)

- **Roles that can view email in the Activity formatter when including “Sent/Received Emails”**: [Role]

- **Number of journal entries (Additional comments, Work notes, etc.) included in email notifications**: 3

### Inbound Email Configuration

- **Email receiving enabled**: (Yes)
  - Identify email as a reply by these subject prefixes: (Yes)

- **Identify email as a forward by these subject prefixes**: (Yes)

- **Forward**:

- **Discard everything below this text if found in a reply body (comma separated, case sensitive)**:

- **Automatically create users for incoming emails from trusted domains**: (Yes)

- **Default password for users created from email sent from trusted domains. (must reset upon login)**:

- **Trusted domains when creating new users from incoming email (Ignore email from untrusted domains unless from an existing user; use * for all domains)**:

  - servicenow.com
Email accounts are configured in the **System Mailboxes > Administration > Email Accounts** module. For more information and instructions, see **Configure an email account**.

Email diagnostics are available from the **System Mailboxes > Email Diagnostics** module.

**Note:** To learn more about the security properties that affect email processing, see #unique_1856 and #unique_1857 in Instance Security Hardening Settings.

**Outbound mail configuration**

The **Outbound Mail Configuration** section of the Email Properties page contains properties for sending email.
Outbound Email Configuration

Email sending enabled  ☑

Yes | No

Send all email to this test email address (non-production testing) ☑

Append timezone to dates and times in sent email  ☑

Yes | No

Create visible watermark in sent email. If false, create invisible watermark via hidden div tag. ☑

Yes | No

Resend email if server returns these SMTP error codes  ☑

421,450,451,452

Do not resend email if server returns these SMTP error codes  ☑

500,501,502,503,504,550,551,552,553,554

Resend email when server returns unknown SMTP error codes. ☑

Yes | No

Roles that can view email in the Activity formatter when including "Sent/Received Emails"  ☑

itil

Number of journal entries (Additional comments, Work notes, etc.) included in email notifications (-1 means all).  ☑
### Outbound email properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.smtp.active</td>
<td>Email sending enabled</td>
<td>Specifies whether to enable or disable the outgoing mail server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td>glide.email.test.user</td>
<td>Send all email to this test email address</td>
<td>Specifies the comma-separated list of email addresses to which the instance</td>
</tr>
<tr>
<td></td>
<td>(non-production testing)</td>
<td>sends all email messages. Typically used in non-production instances for</td>
</tr>
<tr>
<td></td>
<td></td>
<td>testing purposes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: none</td>
</tr>
<tr>
<td>glide.email.append.timezone</td>
<td>Append time zone to dates and times in sent</td>
<td>Specifies whether to append the system time zone to date and date/time</td>
</tr>
<tr>
<td></td>
<td>mail</td>
<td>values in outbound emails. For example, 2010-07-02 04:01:14 PST.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td>glide.email.watermark.visible</td>
<td>Create visible watermark in sent mail</td>
<td>Indicates whether the watermark in email notifications is visible (true) or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>wrapped in a hidden div tag (false).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td>glide.smtp.defer_retry_ids</td>
<td>Resend email if server returns these SMTP</td>
<td>Specifies the comma-separated list of SMTP error codes that force the</td>
</tr>
<tr>
<td></td>
<td>error codes</td>
<td>instance to resend email.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 421,450,451,452</td>
</tr>
<tr>
<td>glide.smtp.fail_message_ids</td>
<td>Do not resend email if server returns these</td>
<td>Specifies the comma-separated list of SMTP error codes that prevent the</td>
</tr>
<tr>
<td></td>
<td>SMTP error codes</td>
<td>instance from resending email.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 500,501,502,503,504,550,551,552,553,554</td>
</tr>
<tr>
<td>Property</td>
<td>Label</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| glide.smtp.default_retry      | Resend email when server returns unknown SMTP error codes.          | Enables (true) or disables (false) resending email when an unknown SMTP error code is encountered. The instance only recognizes the SMTP error codes defined in the `glide.smtp.defer_retry_ids` property.  
  • Type: true | false  
  • Default value: true                                                                 |
| glide.ui.activity.email_roles | Roles that can view email in the Activity formatter when including "Sent/Received Emails" | Specifies the comma-separated list of roles that can view email in the activity formatter.  
  • Type: string  
  • Default value: itil                                                                 |
| glide.email.journal.lines    | Number of journal entries (Additional comments, Work notes, etc.) included in email notifications (-1 means all). | Specifies the number of entries from a journal field, such as Additional comments or Work notes, included in email notifications. A value of -1 includes all journal entries.  
  • Type: integer  
  • Default value: 3  
  • Learn More: Restrict the Number of Entries Sent in a Notification |

**Inbound mail configuration**

The Inbound Mail Configuration section of the Email Properties page contains properties to control inbound email.
Inbound Email Configuration

Email receiving enabled  ❔

☑ Yes | No

Identify email as a reply by these subject prefixes  ❔

re:, aw:, r:, Accepted:, Tentative:, Declined:

Identify email as a forward by these subject prefixes  ❔

fw:, fwd:

Discard everything below this text if found in a reply body (comma separated, case sensitive)  ❔

\n\n-----Original Message-----,\n\n ______ \n\nFrom:

Automatically create users for incoming emails from trusted domains  ❔

☐ Yes | No

Default password for users created from email sent from trusted domains. (must reset upon login)  ❔

*******

Trusted domains when creating new users from incoming email (Ignore email from untrusted domains unless from an existing user; use * for all domains)  ❔

servicenow.com
## Inbound email properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.read.active</td>
<td>Email receiving enabled</td>
<td>Specifies whether to enable or disable the inbound mail server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td>glide.email.reply_subject_prefix</td>
<td>Identify email as a reply by these subject prefixes</td>
<td>Specifies the comma-separated list of prefixes in the subject line that identify an email reply.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: re:, aw:, r:, Accepted:, Tentative:, Declined:</td>
</tr>
</tbody>
</table>

**Note:** The case of the reply prefix in the email, for example RE:, must exactly match the case of the prefixes defined in this property. If, for example, an email contains the Re: prefix and only RE: is defined in the property, the email will not be recognized as a reply. Therefore, it is a best practice to define multiple versions of the prefix, including mixed-case versions, such as RE:, Re:, and so on.
<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.email.forward_subject_prefix | Identify email as a forward by these subject prefixes | Specifies the comma-separated list of prefixes in the subject line that identify a forwarded email.  
- Type: string  
- Default value: fw:,fwd:  

**Note:** The case of the forward prefix in the email, for example fw:, must exactly match the case of the prefixes defined in this property. If, for example, an email contains the Fwd; prefix and only fwd: is defined in the property, the email will not be recognized as a forward. Therefore, it is a best practice to define multiple versions of the prefix, including mixed-case versions, such as FWD:, Fwd:, and so on. |
| glide.pop3.reply_separators | Discard everything below this text if found in a reply body (comma separated, case sensitive) | Specifies the comma-separated list of separators that cause the instance to disregard everything below the text string in the message body. This list is case sensitive.  
- Type: string  
- Default value: \n\n----Original Message----,\n\n_____\n\nFrom:  

**Note:** Some email service providers don't support this default format. If your reply emails aren't formatting as expected, edit this property manually. |
<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.pop3readerjob.create_caller</td>
<td>Automatically create users for incoming emails from trusted domains</td>
<td>Controls the behavior when an instance receives an email from an email address not associated with a user record. If this property is set to true, the instance creates a new user record for the email address and places that new user in the Caller field of any tickets created. If the property is set to false, the instance places Guest in the Caller field of any tickets created.</td>
</tr>
<tr>
<td>• Type: true</td>
<td>• Default value: false</td>
<td>• Learn More: Enabling Automatic User Creation</td>
</tr>
<tr>
<td>glide.user.default_password</td>
<td>Default password for users created from email sent from trusted domains. (must reset upon login)</td>
<td>Specifies the password for new users created from incoming email. Users must reset the password at first login.</td>
</tr>
<tr>
<td>• Type: string</td>
<td>• Default value: password</td>
<td>• Learn More: Enabling Automatic User Creation</td>
</tr>
<tr>
<td>glide.user.trusted_domain</td>
<td>Trusted domains when creating users from incoming email.</td>
<td>Comma-separated list of trusted domains for which the instance automatically creates a user based on incoming emails. Use an asterisk (*) to trust all domains. If an email is not from a trusted domain, the instance processes the inbound email as a &quot;guest user&quot; but it does not create a guest user in the instance.</td>
</tr>
<tr>
<td>• Type: string</td>
<td>• Default value: asterisk (*)</td>
<td>• Learn More: Enabling Automatic User Creation</td>
</tr>
</tbody>
</table>

**Note:** To learn more about the security properties that affect email processing, see #unique_1856 in Instance Security Hardening Settings.

**Email image filtering properties**

Use email image filtering properties to control how inbound email images attach to a target record.

When a user sends an email to the system, email images (such as logos or email signatures) attach to the target record by default. These images are also visible in the activity stream of the target record. The
to the target record, and also duplicate images in the activity stream.

To filter images from emails and reduce duplicate image attachments to target records, configure the following properties in the System Properties [sys_properties] table. Use these properties to:

- Specify the email image sizes eligible for filtering.
- Choose an action that controls image attachment behavior and image visibility in the activity stream.

**Note:** These properties do not delete attachments. You can verify attachment records in the Attachments [sys_attachment] table.

### Email image filtering properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.inbound.image_sys_attachment.filter.minimum_bytes</td>
<td>Sets the minimum image size in bytes for inbound email images to attach to the target record. Any image that is below this size limit is subject to the image filtering behavior that you set in the glide.email.inbound.image_sys_attachment.filter.action property. To disable image filtering entirely and attach all email images to the target record, set the minimum byte size to 0.</td>
</tr>
<tr>
<td>glide.email.inbound.image_sys_attachment.filter.action</td>
<td>Specifies the image filtering behavior.</td>
</tr>
</tbody>
</table>

**Note:** Regardless of the action you select, the image is visible when you choose to Preview HTML Email or Show Email Details in the activity formatter.

- **Type:** Choice list
  - AttachTarget - Associate the image to the target record. The image is visible in the activity formatter and in the attachment to the target record.
  - AttachEmail - Attach the image to the email record. The image is not visible in the activity formatter of the target record nor in the attachment to the target record.
  - AttachNone - Do not attach the image to a record. You can select this option to attach the image manually at a later time.
- **Default value:** AttachEmail

### Email digest properties

Several properties are available to manage digest intervals for email digests.

The following properties are available for the email digest feature.
Note: To open the System Properties [sys_properties] table, enter `sys_properties.list` in the navigation filter.

Properties for email digest intervals

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.digest.default_interval</td>
<td>The sys_id of the default email digest interval available to users.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 28d157e07f1332007f005212bdfa9116</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table</td>
</tr>
<tr>
<td>glide.email.digest.max_intervals</td>
<td>The maximum number of email digest intervals that can be defined.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 100</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table</td>
</tr>
<tr>
<td></td>
<td>• Learn more: For details on digest intervals, see Create or modify email digest intervals.</td>
</tr>
</tbody>
</table>

Additional email properties

There are several advanced email properties that you can use to fine tune the way your instance sends or receives email.

You must add these properties to the System Property [sys_properties] table before they can be used to overwrite the defaults.

**com.glide.email.max_read**

Specifies the maximum number of emails a POP3 reader should process concurrently.

- Type: integer
- Default value: 20

**com.snc.on_call_rotation.reminders.showtz**

Specifies whether to show a user's timezone.

- Type: true | false
- Default value: false

**glide.email.allow_duplicate_message_ids**

Allows storing of emails with duplicate message IDs and adds error message "Duplicate message-id encountered, prevented loop."

- Type: true | false
- Default value: false

**glide.email.email_with_no_target_visible_to_all**
Email that is missing a target record or whose target record is the email will allow any user to view the email regardless of their roles. By turning this property to false, the user is restricted unless they sent in the record or have an admin role.

- Type: true | false
- Value: false

`glide.email.inbound.calendar_behavior`
Specifies how the system stores calendar data, such as an invitation or an invitation response. Enter one of these options (not case sensitive):

- Attach: Store the calendar data as an attachment on the associated record, such as the incident or change that triggers an invitation.
- Ignore: Discard the calendar data.
- Inline: Store the calendar data as text in the email Body field.
- Type: string
- Default value: Attach

`glide.email.inbound.convert_html_inline_attachment_references`
Specifies whether to convert inbound email HTML so email images appear in the email HTML body preview. The system displays broken cid (content ID) links in place of images received when this property is disabled. The format in which the system displays an email image depends on the property setting at the time the email is received, not the current property setting.

- Type: true | false
- Default value: true

`glide.email.inbound.generate.missing.html.part`
Enables the system to generate HTML text for inbound emails that contain only a plain text message.

- Type: true | false
- Default value: true

`glide.email.inbound.generate.missing.text.part`

- Type: true | false
- Default value: true

`glide.email.inbound.max_attachment_count`
Sets the maximum number of attachments allowed per inbound email. This property is available starting with the Eureka Patch 4 release.

- Type: integer
- Default value: 30
- Location: System Property [sys_properties] table

`glide.email.inbound.max_body_chars`
Sets the maximum body size in characters allowed per inbound email.

- Type: integer
- Default value: 524288
**glide.email.inbound.max_total_attachment_size_bytes**

Sets the maximum total attachment size in bytes allowed per inbound email. This property is available starting with the Eureka Patch 4 release.

- Type: integer
- Default value: 18874368
- Location: System Property [sys_properties] table

**glide.email.mail_to**

Specifies the email address for sending notifications that use the ${mailto:} variable.

- Type: string
- Default value: SMTP email address that is active by default

**glide.email.name_split**

Specifies the delimiter used between first and last names in an email address. For example, a delimiter of "." (period) in the email address john.smith@company.com tells the system to look for a user record for John Smith.

- Type: string
- Default value: period (.)

**glide.email.notification.save_when_no_recipients**

Controls whether a notification-generated sys_mail record is saved even if there are no recipients. Used in conjunction with other notification recipient logging properties, this property enables troubleshooting problems with notifications.

- Type: true | false
- Default value: false

**glide.email.outbound.header.auto_submitted**

Stores the value used in the "Auto-submitted" outbound email header. Clear the property value to remove the "Auto-submitted" header from all outbound emails. Some spam filters flag auto-generated email as spam.

- Type: string
- Default value: auto-generated

**glide.email.outbound.max_attachment_count**

Sets the maximum number of attachments allowed per outbound email. This property is available starting with the Eureka Patch 4 release.

- Type: integer
- Default value: 30
- Location: System Property [sys_properties] table

**glide.email.outbound.max_body_chars**

Sets the maximum body size in characters allowed per outbound email.

- Type: integer
- Default value: 524288
**glide.email.outbound.max_total_attachment_size_bytes**

Sets the maximum total attachment size in bytes allowed per outbound email. This property is available starting with the Eureka Patch 4 release.

- **Type:** integer
- **Default value:** 18874368
- **Location:** System Property [sys_properties] table

**glide.email.override.url**

Sets the URL to use in emailed links in place of the instance URL. The URL should end with nav_to.do. An example value is: https://servicenow.customerdomain.com/production/nav_to.do. This property is suitable for customers who use custom redirect URLs for their instances.

- **Type:** string
- **Default value:** instance URL

**glide.cms.use_email_override_url**

Forces the system to use the `glide.email.override.url` property, rather than the `glide.servlet.uri` property, when a notification has a link to a CMS page in an instance.

- **Type:** true | false
- **Default value:** false
- **Location:** System Property [sys_properties] table

**glide.email.append.timezone**

Appends the user time zone to all date and time values in outbound email messages (for example, 2018-07-02 04:01:14 PST). The time zone does not show if the system property `glide.sys.time_format` does not have a "z" value. For more information on configuring the time zone in email notifications, see Time zone for email notifications.

- **Type:** true | false
- **Default:** false

**glide.email.remove_illegal_address_quotes**

Removes invalid quotation marks from an inbound email address, thus allowing the inbound email address to be accepted as valid. For example, when you set the property to true, the address "john.doe@example.com" is changed to john.doe@example.com. However, addresses that are formatted as John Doe <'john.doe@example.com'> are removed entirely.

- **Type:** true | false
- **Default:** false

**glide.email.smtp.max_recipients**

Specifies the maximum number of recipients the instance can list in the To: line for a single email notification. Notifications that would exceed this limit instead create duplicate email notifications addressed to a subset of the recipient list. Each email notification has the same maximum number of recipients.

- **Type:** integer
- **Default value:** 100
Specifies how many emails to send through each new SMTP connection. The instance establishes a new SMTP connection if there are more emails to send than the specified value.

- Type: integer
- Default value: 100

**glide.email.text_plain.strip_xhtml**
Indicates whether both outbound and inbound emails that are shown in comments convert the XML to plain text (true) or preserve the XML (false).

- Type: true | false
- Default value: true

**glide.imap.secure**
Specifies whether to enable SSL encryption for connections to the IMAP server.

- Type: true | false
- Default value: false

**glide.imap.secure.port**
Specifies the communications port for IMAP secure connections.

- Type: string
- Default value: 995

**glide.imap.tls**
Specifies whether to start the IMAP server in Transport Layer Security (TLS) mode.

- Type: true | false
- Default value: false

**glide.notification.recipient.exclude_logging**
Master switch to enable or disable logging all reasons a recipient was excluded. If set to true, the subsequent properties dealing with the exclusion of logging are enabled. If it is set to false, none of the subsequent properties relating to the exclusion of logging are enabled. This property cannot suppress log messages generated by the glide.email.test.user property.

- Type: true | false
- Default value: true

**glide.notification.recipient.exclude_logging.device_inactive**
Logs recipients who are excluded because their chosen notification device record is marked as inactive.

- Type: true | false
- Default value: true

**glide.notification.recipient.exclude_logging.device_schedule**
Logs recipients who are excluded based on the **Schedule** field on the New Device for System Administrator form for their chosen notification device.

- Type: true | false
- Default value: true
**glide.notification.recipient.exclude_logging.event_creator**
Logs recipients who are excluded because they initiated the notification event, such as updating an incident record, and the **Send to Event Creator** check box is cleared on the notification record.
- Type: true | false
- Default value: true

**glide.notification.recipient.exclude_logging.invalid_email**
Logs recipients who are excluded because the email address for that user is invalid, for example the @ is missing, or empty.
- Type: true | false
- Default value: true

**glide.notification.recipient.exclude_logging.user_calendar_integration_disabled**
Logs recipients of calendar invitations who are excluded because the **Calendar Integration** field is set to **None** on the user record.
- Type: true | false
- Default value: true

**glide.notification.recipient.exclude_logging.user_inactive**
Logs recipients who are excluded because the **Active** check box is cleared on the user record.
- Type: true | false
- Default value: true

**glide.notification.recipient.exclude_logging.user_notification_disabled**
Logs recipients who are excluded because the **Notification** field is set to **Disabled** on the user record.
- Type: true | false
- Default value: true

**glide.notification.recipient.include_logging**
Master switch to enable or disable logging all reasons a recipient was included. If set to true, the subsequent properties dealing with the inclusion of logging are enabled. If it is set to false, none of the subsequent properties relating to the inclusion of logging are enabled.
- Type: true | false
- Default value: true

**glide.notification.recipient.include_logging.delegate**
Logs recipients who are included because they are delegates of another user.
- Type: true | false
- Default value: true

**glide.notification.recipient.include_logging.event_parm**
Logs recipients who are included because they are in the **parm1** or **parm2** fields of the event record.
- Type: true | false
• Default value: true

**glide.notification.recipient.include_logging.recipient_fields**
Logs recipients who are included via a notification target record, such as an incident record, specified in the **Users/Groups in Field** field for the notification record. The recipient_fields are fields in the target record that contain a recipient to add. For example, if the record that triggered the notification is an incident, and the **assigned_to** field for the incident is listed in recipient_fields, that user is included as a recipient.

• Type: true | false
• Default value: true

**glide.notification.recipient.include_logging.recipient_groups.group_email**
Logs recipients who are included in a group email for any group provided in the notification record’s recipient_groups or the event **parm1** or **parm2** field.

• Type: true | false
• Default value: true

**glide.notification.recipient.include_logging.recipient_groups.manager**
Logs recipients who are included because they manage any group provided in the notification record’s recipient_groups or the event **parm1** or **parm2** field.

• Type: true | false
• Default value: true

**glide.notification.recipient.include_logging.recipient_groups.membership**
Logs recipients who are included via membership in any group provided in the notification record’s recipient_groups or the event **parm1** or **parm2** field.

• Type: true | false
• Default value: true

**glide.notification.recipient.include_logging.recipient_users**
Logs recipients who are included via notification record’s **Users** field (recipient_users).

• Type: true | false
• Default value: true

**glide.notification.recipient.include_logging.subscription**
Logs recipients because they are subscribed via User Notification Preferences.

• Type: true | false
• Default value: true

**glide.pop3.parse_start**
Specifies the text that indicates the beginning of the email body section. The instance parses name:value pairs within this section to set or update field values when processing inbound email actions.

• Type: string
• Default value: none
**glide.pop3.parse_end**
Text indicating the end of the email body section where the instance should parse name:value pairs to update field values when processing inbound email actions.

- Type: string
- Default value: none

**glide.smtp.dateformat**
Specify the date format to use for outgoing email notifications.

- Type: string
- Default value: date format listed in email sender's user record \[sys_user.date_format\]

**glide.smtp.precedence_bulk**
Specifies whether outbound email includes the header "Precedence: bulk". Some spam filters flag bulk email as spam. Set the value to `false` to remove this header from outbound email.

- Type: true | false
- Default value: true

**glide.smtp.send_partial**
Splits outgoing email between valid and invalid recipients. The email is sent only to the valid recipients. A new email containing the invalid recipients is created in the `send-ready` state and attempts to send again.

- Type: true | false
- Default value: false

**glide.smtp.timeformat**
Specify the time format to use for outgoing email notifications.

- Type: string
- Default value: time format listed in email sender's user record \[sys_user.time_format\]

**glide.ui.activity.email.use_display**
Specifies whether to display email addresses or user IDs (display value from the User table) in email headers. If true, the instance searches for a user record with a matching email address. If it cannot find a matching user record, it displays the email address.

- Type: true | false
- Default value: false

**glide.ui.email_client.email_address.disambiguator**
Sets the columns from the User \[sys_user\] table that the autocomplete list displays. Separate each column name with a semicolon character (;).

- Type: string
- Default value: name
- Learn more:Displaying Additional Information in the Email Client Autocomplete

**glide.ui.incident_activity.max_addresses**
Specifies the maximum number of addresses to list in an email audit record. If the number of addresses exceeds this limit, the instance truncates the list after the maximum value and displays an ellipsis character (...).

- Type: string
- Default value: 5

**NotifyAffectedCI.max_rel_level**

Sets a value used by the **Affected ci notifications** business rule, which notifies subscribers when configuration items (CIs) are affected by tasks. The business rule generates notifications for parent CIs up to the level defined by this property. You might need to adjust the property value according to the complexity and depth of your CI relationships.

- Type: integer
- Default value: 5

**Email size limits**

To prevent issues with large email messages, the system enforces configured limits on the maximum allowed email body size, total attachment file size, and number of attachments per email.

An email or attachment that exceeds the system capacity may not be processed as expected. To ensure that your emails and attachments are processed as expected, you can configure properties that limit the size of emails and attachments.

**Message body size limit properties**

Add properties to control the maximum email body size allowed for inbound and outbound email messages.

**Properties**

By default, the system processes up to 524,000 characters in the email body and body_text fields (524 KB each).

You can add and configure system properties **glide.email.inbound.max_body_chars** and **glide.email.outbound.max_body_chars** to increase or decrease the email body size limits. The system truncates the email body when it exceeds the configured limit. For example, if you configure the body size limit of **glide.email.inbound.max_body_chars** to 1,000 characters but receive an inbound email that is 2,000 characters, then the system truncates the email body at 1,000 characters.

Also note that the system cannot process email body or body text larger than 16 MB.

**Message body size limit properties**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.inbound.max_body_chars</td>
<td>Sets the maximum body size in characters allowed per inbound email.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 524288</td>
</tr>
</tbody>
</table>
### Inbound email body processing

For inbound emails, the system enforces the maximum body size as set by the `glide.email.inbound.max_body_chars` property. When the body size exceeds the configured value:

- The system does not run inbound email actions that would otherwise be triggered by the email.
- The system truncates the Body text on the Email form.
- The system logs a warning and sets the Error string field on the Email form. The log message for such an email might look like this:

```
Email set to receive-ignored because its size exceeds the value set in glide.email.inbound.max_body_chars. 1995 character(s) were truncated from the body field.
```

### Outbound email body processing

For outbound emails, the system enforces the maximum body size as set by the `glide.email.outbound.max_body_chars` property. When the body size exceeds the configured value:

- The system does not send the email.
- The system truncates the Body text on the Email form.
- The system logs a warning and sets the Error string field on the Email form. The log message for such an email might look like this:

```
Email set to send-ignored because its size exceeds the value set in glide.email.outbound.max_body_chars. 1337 character(s) were truncated from the body field.
```

### Attachment limit properties

Several properties control email attachment limits.

To see the status of all email attachments, go to the Email Attachments [sys_email_attachment] table.

### Properties

All the properties are located in the System Property [sys_properties] table. Setting any of the following properties to an excessively large value may cause performance issues.
## Attachment limit properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Type</th>
<th>Default value</th>
<th>Learn more</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.inbound.max_attachment_count</td>
<td>Sets the maximum number of attachments allowed per inbound email.</td>
<td>integer</td>
<td>30</td>
<td>Inbound Email Attachment Processing</td>
</tr>
<tr>
<td>glide.email.inbound.max_total_attachment_size_bytes</td>
<td>Sets the maximum total attachment size in bytes allowed per inbound email.</td>
<td>integer</td>
<td>18874368</td>
<td>Inbound Email Attachment Processing</td>
</tr>
<tr>
<td>glide.email.outbound.max_attachment_count</td>
<td>Sets the maximum number of attachments allowed per outbound email.</td>
<td>integer</td>
<td>30</td>
<td>Outbound Email Attachment Processing</td>
</tr>
<tr>
<td>glide.email.outbound.max_total_attachment_size_bytes</td>
<td>Sets the maximum total attachment size in bytes allowed per outbound email.</td>
<td>integer</td>
<td>18874368</td>
<td>Outbound Email Attachment Processing</td>
</tr>
</tbody>
</table>

### Inbound email attachment processing

For inbound emails, the system enforces the maximum number and size of attachments as set by the `glide.email.inbound.max_attachment_count` and `glide.email.inbound.max_total_attachment_size_bytes` properties. When an attachment for an inbound email exceeds either value, the attachment is discarded. A record is created in the Email Attachments...
[sys_email_attachment] table containing the discarded file name and the reason it was discarded. The discarded file remains in the Email [sys_email] record. The order in which the system processes the attachments determines which attachments are discarded. This order may not be consistent from email to email.

When an inbound email attachment is discarded, the system also fires the inbound.email_attachments.discarded event. You can use the event to trigger a notification that alerts the email sender. For an example of a notification that can be triggered by the event, see the inactive "Demo Email Attachment(s) Discarded" notification.

Inbound email attachments are prevented from attaching to the target record if an identical attachment exists.

Outbound email attachment processing

For outbound emails, the system enforces the maximum number and size of attachments as set by the glide.email.outbound.max_attachment_count and glide.email.outbound.max_total_attachment_size_bytes properties. Email records are created from various sources and may exceed the configured attachment limits.

Emails that are ready to be sent from the Email [sys_email] table are subject to the outbound attachment limits. Emails that exceed either limit trigger a warning in the email system log and are sent with attachments up to the maximum number or total file size.

The log message for such an email might look like this: Maximum combined attachment size exceeded. (max:15728640 bytes). One or more attachment records ignored.

Emails for notifications, scheduled reports, and exported tables

Notifications can be set to include all the attachments from the record that triggers the notification. If the attachments exceed either of the outbound email attachment limits, the system excludes the excess attachments from the email and logs a warning message.

Reports can be scheduled for email distribution as attachments. Large reports may exceed the outbound attachment size limit. In this case, the system sends the scheduled report email without the report attached and logs a warning message. To avoid the issue, send links to large reports instead of sending the reports as attachments.

If a user attempts to export numerous records from a list that exceeds a configured warning threshold, a dialog box offers the option to email the exported records as an attachment. If the attachment exceeds the outbound attachment size limit, the system sends the email without the exported record list attached and logs a warning message.

Domain separation and Notifications

This is an overview of domain separation and the Notifications application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Support: Level 2

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.
Domain separation is specifically supported in Notifications but not in email accounts. Notifications are not data-separated but they are process-separated. Notifications are also triggered by specific actions.

**How domain separation works in Notifications**

There are two basic components of domain separation and Notifications.

- Notifications are process-separated (not data-separated).
- Notifications are triggered in two main ways:
  1. When a record is Inserted or Updated
     - Notifications with matching conditions AND in the same domain as the inserted/updated record are processed.
  2. When an event defined in the notification is triggered
     - Events typically have a target record. For example, [incident.inserted] event references the incident record being inserted.
     - When an event is fired, notifications configured for that event in the same domain as the event’s target record are processed.

**Domains and email accounts**

Domain separation is not supported in email accounts for these reasons:

1. Sending mail: There is only one SMTP sender per account. This prohibits providing domains for each account, and they are not configurable.
2. For receiving Inbound mail: You can set up multiple email accounts but cannot meaningfully set the domain of an inbound email action. Inbound Actions are processed in the domain of the user who sent the email. For example: User_A in Domain A sends an email to a ServiceNow email account which executes the “Create an incident” inbound email action. The resulting new incident created by the inbound action is in Domain A.

To learn more see [Inbound email actions](#).

**Note:** If the number of email accounts exceeds 20, reception of email slows down.

**Use case**

- If an instance is using the Domain separation plugin and a new email notification is defined for a domain that has the same event as the notification on the global domain, the user receives two emails for the same event.

  Solution: Set the [sys_overrides] field on the notification that belongs to the domain so it overrides the setting on global. For more information, see [Delegated administration](#).

**Next steps after enabling email**

After enabling email on your instance, consider performing several of these important tasks.
• Test the email configuration by routing all email to a single user (set the `glide.email.test.user` property).
• Review the baseline notification categories, email notifications, and templates to determine if they meet your business needs.
• Review the baseline inbound email actions to determine if they meet your business needs.
• Determine if you want to use email layouts to add consistent content elements.
• Determine if you want to use email filters to restrict the email the instance receives.
• Determine if you want to implement a retention policy to archive and destroy email at certain intervals.
• Determine what kind of watermarks outbound email uses to associate records with email messages.
• Determine if you want to create users when the instance receives an email from an unrecognized user.
• Set the precedence of outgoing mail. By default, the instance sends email with a precedence of bulk (set the `glide.smtp.precedence_bulk` property).
• Consider preventing untrusted users from triggering inbound actions to prevent unwanted email from affecting your instance.
• Implement a spam filter to restrict unwanted messages sent to your custom email addresses.

Create notification categories

You can create notification categories to identify and group related notifications that are listed in the notification settings for your users.

Role required: admin

Before adding new categories, review the base system notification categories in the Notification Categories [sys_notification_category] table to determine if you need a new category.

1. Navigate to System Notification > Email > Notification Categories.
2. Click New.
3. Enter the Name of the category to identify the family of notifications. Provide a category name that is meaningful to your users, so that they can easily find their notifications under the appropriate category in their notification settings.
4. Enter a Short description to identify the category.
5. Click Submit.

The system adds the new category to the Notification Categories [sys_notification_category] table. After you create at least one, active notification that uses the new category, the category and notification are listed in the notification settings for users (Notifications tab in the System Settings window).

Create an email notification

Creating an email notification involves specifying when to send it, who receives it, what it contains, and if it can be delivered in an email digest.

Role required: admin

Consider the following items when you create or update a notification:

• Your notification recipients must be active users and have a valid email address defined.
  ServiceNow users or members of groups must be defined as active users in the User [sys_user] table. They must also have a valid email address defined for their primary channel (device) in the Notification Device [cmn_notif_device] table. If users do not have an active profile and a valid email address, they will not receive notifications.
• Your notification recipients must have the appropriate notification preferences enabled.
  If the notification is subscribable, each ServiceNow user or group member must have the notification and channels (devices) for the notification enabled in their notification preferences. Admins can impersonate users to review and configure their notification preferences.
To have your email notification also send as an SMS notification, recipients must subscribe to the notification on an SMS channel. For more information on creating an SMS channel, see Create notification channels.

After you create or update the notification, use the Preview Notification option to examine it. For example, you can test links that you may have added and verify the notification recipients. For details, see Preview email notifications.

Use the following tabs in the Notification form to configure an email notification:

- **When to send** — Conditions required to send the notification.
- **Who will receive** — Recipients of the notification.
- **What it will contain** — Contents of the notification.
- **What Digest will contain** — Contents of the email digest if the notification can be delivered in a digest.

**Note:** If you do not see all the fields on the form, switch to the Advanced view.

Watch this six-minute video to learn about the actions that the instance can take in response to messages from users and shows how to create or modify email notifications to users. In the video, skip to 3:29 for details on configuring email notifications.

1. Navigate to **System Notification > Email > Notifications**.
2. Click **New**.

3. Fill in the fields at the top of the Notification form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the email notification. Descriptive names help identify the purpose of the email notification. For example, Incident Opened &amp; Unassigned.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table</td>
<td>Select the database table to link the notification to, for example Incident [incident].</td>
</tr>
<tr>
<td></td>
<td><strong>Attention:</strong> Do not select the Task [task] table. This table is for extending other tables. Notifications that run on the Task table directly are not supported.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only tables and database views that are in the same application scope appear in the list.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of notification you are creating: EMAIL or Meeting Invitation.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to enable the email notification.</td>
</tr>
<tr>
<td>Category</td>
<td>Select the category to which this notification belongs. A category identifies and groups related notifications. This notification, if active and subscribable, is listed in the selected <strong>Category</strong> in the notification preferences for each user (<strong>Notifications</strong> tab in the System Settings window).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Do not leave the category as <strong>Uncategorized</strong>, as users may not be able to find the notification in their list of notifications.</td>
</tr>
<tr>
<td></td>
<td>If you need a new category, see Create notification categories.</td>
</tr>
<tr>
<td>Allow Digest</td>
<td>Select the check box if an email digest is to be created for the notification. If selected, the <strong>What Digest will contain</strong> tab is displayed for creating the digest content.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a description for this notification.</td>
</tr>
</tbody>
</table>
4. Fill in the fields on the **When to send** tab.

**Note:** If the same trigger generates multiple notifications, the system only sends one notification. The system considers all other notifications, even if they have a different subject and body, as duplicates. The Ignore Duplicates business rule controls this functionality.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send when</td>
<td>Select under what condition the notification is sent:</td>
</tr>
<tr>
<td></td>
<td>• When a record is inserted or updated</td>
</tr>
<tr>
<td></td>
<td>• When a particular event is fired</td>
</tr>
<tr>
<td></td>
<td>• When triggered as an action step in Flow Designer</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion

**Now Platform capabilities**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Weight</strong></td>
<td>[Required] Set a numerical value for the notification priority relative to duplicate notifications.</td>
</tr>
<tr>
<td></td>
<td>Notifications that have the same target table and recipients, or the same subject and body, are considered duplicates. When there are duplicate notifications, the system only sends the notification with the highest weight. All other notifications are moved from the Outbox to the Skipped mailbox. The default value 0 causes the system to always send the notification (assuming the conditions are met).</td>
</tr>
<tr>
<td></td>
<td>For example, suppose that a service desk agent adds a comment to an incident and shortly thereafter closes it. By default, these actions trigger both the Incident commented and Incident Closed notifications.</td>
</tr>
<tr>
<td></td>
<td>However, both notifications are from the Incident table and also notify the incident caller. The system only sends the notification with the highest weight, which in this case is the Incident Closed notification.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The SMTP Sender scheduled job determines how often to send email. By default, this job runs every minute.</td>
</tr>
<tr>
<td><strong>Conditions</strong></td>
<td>Use the condition builder to select the conditions under which this notification is sent. For example, select <strong>Priority &gt; greater than &gt; 3 - Moderate</strong> to send the notification only for High and Critical priority incidents.</td>
</tr>
<tr>
<td><strong>Inserted</strong></td>
<td>Select the check box to enable email notification when a record is inserted. This field appears when you set the <strong>Send when</strong> field to <strong>Record inserted or updated</strong>.</td>
</tr>
<tr>
<td><strong>Updated</strong></td>
<td>Select the check box to enable email notification when a record is updated. This field appears when you set the <strong>Send when</strong> field to <strong>Record inserted or updated</strong>.</td>
</tr>
<tr>
<td><strong>Event name</strong></td>
<td>Select the event that triggers this notification. This field appears when you set the <strong>Send when</strong> field to <strong>Event is fired</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Advanced condition | Create a script to perform certain actions, like sending a notification based on the current email record, changing field values, or changing system properties.  
The advanced condition script must return true or set a global answer variable to true to send the notification.  
The advanced condition script uses the following global variables:  
• current: Contains the current record from the table to which the notification is linked.  
• event: Contains the event that triggered the notification. |

**Note:** The Advanced condition field is evaluated in addition to other conditions you set on the notification. Both the condition and advanced condition must evaluate to true to send the notification.

5. Fill in the fields on the **Who will receive** tab.

The following example shows the default view of the tab. The advanced view contains additional fields (see table).

**Tip:** Consider limiting the recipient list of any notification to 1000 users. By default, if a notification has more than 100 intended recipients, the system creates multiple notification...
messages with up to 100 recipients each. If you want to change the recipient limit, set the system property `glide.email.smtp.max_recipients`.

### Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Select the users you want to receive the email notification. You can search for users with the reference lookup icon or manually add their email addresses. This list of users is static.</td>
</tr>
<tr>
<td>Users/groups in fields</td>
<td>Select fields from the target record that reference the User [sys_user] or Group [sys_user_group] tables. The system sends the notification to users or groups in each field that you select. For example, if a notification uses the Incident [incident] table, you can select the <strong>Opened by</strong> field to send the notification to users or groups who opened the incident. This list of users or groups is variable and depends upon the values of the associated task record. You can also select a field that includes an email address string to send a notification to that address.</td>
</tr>
</tbody>
</table>

**Note:** You can dot-walk to values in reference fields by clicking the plus sign in the field selector and then selecting the related field.

If you address the notification to a user with an inactive record in the User [sys_user] table, the system does not send the notification to that user.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Groups</td>
<td>Select the groups you want to receive the email notification. You can search for groups with the reference lookup icon or by manually entering the group name. This list of groups is static.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Group members receive individual notifications only if <strong>Include members</strong> is selected in the group record.</td>
</tr>
<tr>
<td>Exclude delegates</td>
<td>Select this option to prevent the instance from sending email notifications to delegates of the users and members of the groups you selected.</td>
</tr>
<tr>
<td>Send to event creator</td>
<td>Select this check box to send the notification to the person who performed the action that started the notification process if the person is also a recipient. If the event creator is not specified in one of the recipient fields, the event creator does not receive a notification regardless of the setting in this field. For new notifications, this option is selected by default. If you want to know why you may not be receiving certain email notifications, see the blog post <em>Troubleshooting email notifications - Send to the Event Creator</em> by a ServiceNow Technical Support Engineer in the ServiceNow Now Community.</td>
</tr>
<tr>
<td>Event parm 1 contains recipient</td>
<td>Select this check box if the event parameter 1 contains one or more notification recipients (in a comma separated-list). This field is visible only when the <strong>Send when</strong> field is set to <strong>Event is fired</strong>.</td>
</tr>
<tr>
<td>Event parm 2 contains recipient</td>
<td>Select this check box if the event parameter 2 contains one or more notification recipients (in a comma-separated list). This field is visible only when the <strong>Send when</strong> field is set to <strong>Event is fired</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Subscribable</td>
<td>Select this check box to allow all users to subscribe to this notification. See Subscription-based notifications for more information.</td>
</tr>
</tbody>
</table>

**Note:** If the record contains sensitive or protected data, consider restricting the recipient list only to those users and groups who normally have access to it, and do not enable the **Subscribable** option. You can also configure your notification content so that private or sensitive data is not exposed. For example, you could insert a link back to the associated record, so that details are not revealed in the notification.

The system does not exclude recipients based on access controls. Recipients can receive email about records that they cannot normally access from the user interface. For example, requesters can receive email about incidents and catalog requests opened on their behalf even though they normally do not have access to these records. If a notification includes record details, verify that all recipients need these details.

**Note:** By default, the system does not send email notifications to itself. For example, an email notification from instanceABC@service-now.com does not send to instanceABC@service-now.com. The system prevents this behavior to avoid looping.
6. Fill in the fields on the **What it will contain** tab.
The following example shows the default view of the tab. The advanced view contains additional fields (see table).
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Email template  | If you want to reuse existing content, select an email template to add content to the email notification. You can only select an email template that meets one of the following conditions:  
• shares the same scope and table as the notification  
• shares the same scope but has no specified table  
• shares the same table and is in the global scope |
| Subject         | Enter the subject line for the email message. The subject can include variables from the Select variables column.  
If empty, the system uses the Subject value from the Email template. If you enter a value in this field, it overrides the template value.  
If your recipients subscribe to the email notification on an SMS channel, then the system sends the email notification subject as an SMS message. To send a different SMS message, fill in the SMS alternate field on the email template form or the email notification form. |
| Message HTML    | Enter the content of the email notification message. The message can include variables from the Select variables column.  
Variables map to column names available from the notification table, its parent tables, and reference tables. Use variables to include values from a record in the table such as an incident short description or comments and work notes.  
The Message HTML field is visible only if you set the content type to HTML and plain text or HTML only.  
If empty, the system uses the Message HTML value from the Email template. If you enter a value in this field, it overrides the template value.  
To prevent adding extra `<p>` and `<div>` elements to your email notifications, see the blog post Extra line spacing with paragraph tags in email client by a ServiceNow employee in the ServiceNow Now Community. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMS alternate</td>
<td>Enter the notification message to send to an SMS device. The SMS alternate message is limited to 140 characters. If empty, the system uses the SMS alternate value from the Email template. If you enter a value in this field, it overrides the template value. If you don't fill in the SMS alternate field on this form or the email template, then the system uses the email notification subject as the SMS message.</td>
</tr>
<tr>
<td>Importance</td>
<td>Set the importance of the email message to low or high.</td>
</tr>
</tbody>
</table>
| Content type     | Select the content type for the email notification:  
• HTML and plain text  
• HTML only  
• Plain text only  
By default, HTML only is enabled.                                                                                                                                                                                                                                           |
<p>| Include attachments | Select this check box to send all attachments from the triggering record as email attachments.                                                                                                                                                                                                                                           |
| Omit watermark   | Use this check box to apply or remove the watermark attached to each email. If the email does not contain a watermark, the system reviews the conditions of the inbound actions to create or update task records. For more information, and an alternative way to hide watermarks, see Watermarks on notification emails. |
| Message Text     | Enter the notification message to send in plain text. This field appears when you set the content type to HTML and plain text or Plain text only. If empty, the system uses the Message Text value from the Email template. If you enter a value in this field, it overrides the template value. |
| From             | Enter the email address that you want the email notification to use in the From field. For example, <a href="mailto:helpdesk@yourcompany.com">helpdesk@yourcompany.com</a>. The email must be in a valid format, otherwise a notification message appears near the field. Changing this address may require an advanced email setup such as enabling email forwarding, for example when using Sender Policy Framework (SPF) records for spam detection. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reply to</td>
<td>Enter the email address you want people to use when replying to the email notification. For example, <a href="mailto:helpdesk@yourcompany.com">helpdesk@yourcompany.com</a>. The email must be in a valid format, otherwise a notification message appears near the field. You can add no more than one email address in this field. Changing this address requires an advanced email setup such as enabling email forwarding.</td>
</tr>
<tr>
<td>Push message only</td>
<td>Select this option to send this notification only as a push notification to a mobile device. The Push Notification feature must be active.</td>
</tr>
<tr>
<td>Push messages</td>
<td>Associate one or more push messages with this notification. The Push Notification feature must be active.</td>
</tr>
</tbody>
</table>

**Note:** The push message and notification must be for the same table.
7. If you selected the **Allow Digest** check box, fill in the fields on the **What Digest will contain** tab to create the email digest content for the notification. The following example shows the default view of the tab. The advanced view contains additional fields (see table).
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digest Template</td>
<td>If you want to reuse existing content, such as headers or footers, select an email template to add content to the email digest.</td>
</tr>
<tr>
<td>Digest Subject</td>
<td>Enter the subject line for the email digest. The subject can include variables from the Select variables column. If empty, the system uses the Subject value from the Email template. If you enter a value in this field, it overrides the template value.</td>
</tr>
<tr>
<td>Digest HTML</td>
<td>Enter the recurring content for the email digest. The digest content can include variables from the Select variables column. Variables map to column names available from the notification table, its parent tables, and reference tables. Use variables to include values from a record in the table such as an incident short description or comments and work notes. To prevent adding extra &lt;p&gt; and &lt;div&gt; elements to your email digest, see the blog post Extra line spacing with paragraph tags in email client by a ServiceNow employee in the ServiceNow Now Community.</td>
</tr>
<tr>
<td>Digest Separator (HTML)</td>
<td>Use the line to separate each item summarized in the digest.</td>
</tr>
<tr>
<td>Digest From</td>
<td>Enter the email address to be used in the From field of the email digest. For example, <a href="mailto:helpdesk@yourcompany.com">helpdesk@yourcompany.com</a>. The email address must be in a valid format, otherwise a notification message appears near the field. Changing this address requires an advanced email setup such as enabling email forwarding.</td>
</tr>
<tr>
<td>Digest Reply To</td>
<td>Enter the email address that you want people to use when replying to the email digest. For example, <a href="mailto:helpdesk@yourcompany.com">helpdesk@yourcompany.com</a>. The email must be in a valid format, otherwise a notification message appears near the field. Changing this address requires an advanced email setup such as enabling email forwarding.</td>
</tr>
<tr>
<td>Digest Text</td>
<td>Enter the recurring content of the email digest to send in plain text. This field appears when you set the content type to HTML and plain text or Plain text only.</td>
</tr>
</tbody>
</table>
### Field: Digest Separator (text)

**Description:**

[Optional] Use the dash character as a line to separate each item summarized in the digest. This field appears when you set the content type to **HTML and plain text** or **Plain text only**.

---

When you save or update the notification, the email **Digest** option is available for the notification in the notification settings of your users.

8. When you finish creating the notification, click **Submit**. Or, if you are done modifying the notification, click **Update**.

Use the **Preview Notification** option to check your notification. For example, you can see:

- How the **Subject** and **Message** fields are displayed.
- Which users will or will not receive the notification, including the reasons why users will not receive it.

**Convert legacy email notifications to rich HTML**

By default, new email notifications are created in the rich HTML format. But you can also convert legacy notifications to rich HTML.

Role required: admin

1. Navigate to **System Notification > Email > Notifications**.
2. On the **Email Notifications** list screen, click the name of the email notification you want to convert.
3. Click the **What it will contain** tab.
When to send | Who will receive | What it will contain

Content type: HTML and plain text
Importance: -- None --

Include attachments

Omit watermark

Push Message Only

Push Messages: Notify test case user

Email template

Subject: Test notification: New test assigned to you on $(metric_type) - due by $(due_date)

Message:
You have been assigned to complete tests on $(metric_type). Please follow the link below and complete the tests by $(due_date). You can save your results until you are ready to submit them. When you have completed the tests, and filled in all final results, submit the test.

Click here to begin the test:
<email_script>
var link = new Assessment/UI/3.js[getAssessmentInstanceURL(current.sys_id)];
var url = "a.href=" + link + "#/view/';
template.printUrl();
</email_script>

To view your test queue at any time, sign in and navigate to Sell > My Tests.

SMS alternate

Select variables:
4. Click **Switch to Rich HTML Editor**.
   
The system copies any raw HTML from the **Message** field and converts it to rich HTML in the **Message HTML** field. Additionally, any mail scripts in the body are automatically saved to the Email
Script [sys_script_email] table and are replaced in the notification body with an embedded script tag. This makes the notification body easier to read.
Notification - Notify test user (Advanced view)

<table>
<thead>
<tr>
<th>When to send</th>
<th>Who will receive</th>
<th>What it will contain</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content type</td>
<td>HTML and plain text</td>
<td>Importance -- None --</td>
</tr>
<tr>
<td>Include attachments</td>
<td>From</td>
<td></td>
</tr>
<tr>
<td>Omit watermark</td>
<td>Reply to</td>
<td></td>
</tr>
<tr>
<td>Push Message Only</td>
<td>Push Messages</td>
<td>Notify test case user</td>
</tr>
<tr>
<td>Email template</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subject</td>
<td>Test notification: New test assigned to you on $(metric_type) due by $(due_date)</td>
<td></td>
</tr>
</tbody>
</table>

Message HTML

You have been assigned to complete tests on $(metric_type). Please follow the link below and complete the tests by $(due_date). You can save your results until you are ready to submit them. When you have completed the test, and filled in all final results, submit the test.

Click here to begin the test:
$(mail_script:Notify test case user_script_1)

To view your test queue at any time, sign in and navigate to Self-Service > My Tests.
When you convert an email notification that was created in a version prior to Eureka to rich HTML, mail scripts are automatically moved to the Email Script [sys_script_email] table and an embedded script tag with the name of the script is automatically inserted into the body of the notification.

When creating new email notifications, write mail scripts using System Notification > Email > Notification Email Scripts. When the scripts are completed, add a \$\{mail_script:script name\} embedded script tag to the email notification body. This makes it easy to use the same scripts in multiple email notifications. All you need to copy and paste from one notification to the next is the embedded script tag.

If you manually enter a mail script, any text bounded by <mail_script> </mail_script> in the body of a new or converted email notification or template which is saved to the record, a message asks whether the mail script should be converted.

In many cases, an unconverted mail script fails to run from inside the HTML editor. If you select Yes, the script is added to the Email Script [sys_script_email] table and is automatically replaced in the body with an embedded script tag. You can view the mail scripts in their original form by opening the email notification and clicking the Show Notification Scripts related link.

Control visibility to email records generated by notifications
Define conditions that restrict read access to target email records containing sensitive information.

Role required: admin

Use the Email Access Restriction [email_access_restriction] table to define conditions that control read access to an email record generated by a notification containing sensitive information. These conditions are processed by the base system ACL for the Email [sys_email] table.

When you specify conditions to restrict access for a notification, the email records are visible only to users that match the conditions specified for the notification.

1. Navigate to System Notification > Email Access Restriction.
2. Click New.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification</td>
<td>Choose the notification that generates the email record that should be restricted.</td>
</tr>
<tr>
<td>Application</td>
<td>Displays the application scope.</td>
</tr>
<tr>
<td>Table</td>
<td>Displays the target table for the notification that you selected.</td>
</tr>
<tr>
<td>Condition</td>
<td>Use the condition builder to determine who can access the email record. The conditions must evaluate to true to enable read access to the email record.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a short description of the read access restriction.</td>
</tr>
</tbody>
</table>

4. Click Submit.

**Advanced conditions for email notifications**

Use an advanced condition to send a notification based on the current email record, changing field values, or system properties.

To send a notification using an advanced condition, you can:

- Call a function that returns a value, or
- Set the global variable `answer` using a script

For example, in the following code, you call a function to prevent the system from sending an email notification if the sender of a self-service request is a member of the XYZ group:

```javascript
(function() {
    var groupMember = gs.getUser();
    return !groupMember.isMemberOf('XYZ');
})();
```

Alternatively, you can script the same advanced condition by using the `answer` variable:

```javascript
var groupMember = gs.getUser();
if(groupMember.isMemberOf('XYZ')){
    answer = false;
} else {
    answer = true;
};
```

Note that the script must set the `answer` variable to `true` to send the notification. If you script no conditionals, the value of `answer` is equal to the last value that you set for the variable.

You can add a script-based condition in the **Advanced condition** field by configuring the Email Notification form and adding the field. You can access the field in the **Advanced** view without configuring the form.

The advanced condition script uses the following business rule global variables:

- `current`: contains the current record from the table to which the notification is linked.
- `event`: contains the event that triggered the notification.

**Note:** The **Advanced condition** field is evaluated in addition to other conditions you set on the notification. Both the **Condition** and **Advanced condition** must evaluate to true in order to send the notification.
Edit HTML content in an email notification

For added control over the content of an email notification, you can edit the underlying HTML.

Role required: admin

1. Navigate to System Notification > Email > Notifications.
2. Open an email notification record.
3. On the form, open the What it will contain tab.
4. In the Message HTML field, click the source code icon (_left_right) to open the HTML source code editor.

5. Make the needed changes to the HTML.
6. On the window, click Ok.
7. On the form, click Update.
Document attachments on an email notification
You can attach documents and reports to email notifications by scripting or linking to the sys ID of the record.

You can include all attachments from the source record with the notification. For example, if an incident update generates a notification, you can include all attachments from the incident record with the notification. To include all attachments from the source record, select the check box for the Include attachments field. Note that email messages, including attachments, cannot exceed the maximum email size. This size includes MIME encoding. For details on MIME encoding, see Email service size restrictions.

Attaching documents with scripting
Using scripting, you can attach documents by linking to them, or you can attach various types of reports by specifying their IDs in the system.

Linking to an attachment
You can add an attachment to a notification by linking to the attachment record in the message of the notification. Upon clicking the link, email recipients log in to the instance to view the attachment record.

Linking to attachment records in this fashion requires using email notification scripting. For example:

```
template.print ( 'Attachment: <a href="/sys_attachment.do?sys_id=' + now_GR.sys_id + '"></a>' + now_GR.file_name + '</a><br>
')
```

Attaching reports using the Sys ID
You can also attach various types of reports, including gauges, dashboards, and charts, to a notification. The scripts to attach these reports take the following syntax:

```
${report:X:Y}
```

where:

- **X** is the type of report you want to attach (reportID, gaugeID, dashboardID, or chartID).
- **Y** is the sys ID of the report, gauge, dashboard, or chart to be attached.

For example:

- `${report:reportID:<abc123>}`
- `${report:gaugeID:<abc123>}`
- `${report:dashboardID:<abc123>}`
- `${report:chartID:<abc123>}`

**Note:** Multilevel pivot reports can’t attach to email notifications.

Line breaks in email notifications and rich HTML
Rich HTML provides additional control over line breaks in your email notifications and templates.

To provide control over line breaks, a Newlines to HTML check box is available in the Email Script form.
Newlines to HTML option

Selecting the **Newlines to HTML** check box indicates that the method for handling line breaks in earlier versions carries forward for email notifications and templates. When an email notification or template is converted to rich HTML, the **Newlines to HTML** check box is automatically selected.

For new mail scripts, add correct HTML line breaks to template.print() statements.

If an email notification or template is not converted to rich HTML, newlines are automatically wrapped with `<div>` tags, the same as previous versions. The old mail scripts still work. However, the administrator does not enjoy the benefits of working in the rich HTML format, and does not have as much control over exact HTML formatting.

**HTML line breaks in new scripts**

When writing new scripts, insert explicit HTML line breaks and clear the **Newlines to HTML** check box so that no HTML tags are injected when email notifications are generated. For existing notifications and templates, replace template.print("\n") JavaScript function calls with template.print("<br/>"). This replacement gives you better control over the HTML formatting of your email notifications.
Preview email notifications

You can preview what notifications look like before you actually enable the instance to send them.

Role required: admin

You can preview both types of notifications as specified by the Send when field on the Notification form:

- **Record inserted or updated**: A change to record in the instance triggers the notification.
- **Event is fired**: An event, such as expiration of a certificate or an inbound email action, triggers the notification.

1. Navigate to System Notification > Email > Notifications.
2. Open the notification or create one.
   You must save the record before you can view the preview accurately.
3. Click Preview Notification on the form header.
4. On the Notification Preview window, verify that the notification works as expected.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview records for this breakdown source</td>
<td>The type of event that triggers the notification. This choice list appears if you preview an event-triggered notification. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Generated Event</strong>: Preview the notification with a generic event that the previewer creates. This does not actually generate an event record.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Existing Event</strong>: Preview with an existing event record in the instance. If you select this option, select the event in the Event Record field.</td>
</tr>
<tr>
<td>Event Record</td>
<td>An existing event to preview an event-created notification. This option appears if you select <strong>Existing Event</strong> as the event type (for event-triggered notifications only).</td>
</tr>
<tr>
<td>Event Creator</td>
<td>The user triggering the notification for the purpose of the preview. The event creator defaults to the user who clicked Preview Notification. You can change the creator as needed. You can change the preview record as needed to see the changes in the notification content.</td>
</tr>
<tr>
<td>Preview Record</td>
<td>The record triggering the notification for the purpose of the preview. The preview record defaults to one of the records in the table specified in the Table field on the Email Notification form. You can change the preview record as needed to see the changes in the notification content.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Users | The users who will receive the notification, as specified in the **Who will receive** section of the Email Notification form:
- All users that you specify on the form appear, but only the users that will actually receive the notification with the current preview settings appear in black text.
- Users that are specified but for whatever reason will not receive the notification appear in red, strikethrough text. Place the cursor over any of these names to see the reason the user will not receive the notification. For example, one reason could be that the user's notification settings are disabled.

Subject and Body | The content of the notification as defined by the template. The **Subject** and **Body** sections on the preview display the content in the corresponding **Subject** and **Message** fields on the template.
If the template includes a link to the record that triggered the notification, the **Preview Record** link is used. Click the link to go to that record.

5. After you have reviewed the notification, exit the preview window.
6. Make the necessary changes to the notification or template, if necessary.

**Time zone for email notifications**
A system property controls the time zone that the instance uses for the date and time stamp of a message.

The date and time stamp of a notification uses the system time zone, not the time zone of any recipient.
The email property `glide.email.append.timezone` controls whether to append the time zone. If true, the system time zone of the instance is appended to any Date/Time fields in outbound email messages (for example, `2018-07-02 04:01:14 PST`).

**Specify alternative outbound email addresses for notifications**
By default, the system sends all outbound email notifications from the default email address of the instance, but you can specify an alternative address.

Role required: admin

For organizations that need to send email messages from specific email addresses, such as from multiple service desks, or they want to send notifications in different languages, the platform supports configuring multiple outbound addresses.

1. Navigate to **System Notification > Email > Notifications**.
2. Select an existing notification record for the desired event, such as **Incident Closed**.
3. Create a copy of this notification for each outbound email address.
4. Open one of the notification copies, and click the **Advanced view** related link.
5. In the **What it will contain** section, add an email address to the From field that is different from the default instance address.

For more information on how to construct the From address, refer to section 3.6.2 of **RFC 2822**.
6. Add a different email address than the From address to the Reply to field if you want replies to this notification to go to a different address.

   The system checks the From field for an address. If this field is empty, then the system uses the default address for the instance. If the Reply to field is empty, then all replies are sent to the address from which the notification was sent. If the Reply to field contains an email address, then the system sends all replies to the notification to this address.

7. Create mutually-exclusive conditions for notifications of the same type, so only the desired notification is sent when the event is fired.

   For example, if the Company is a certain value, then the notification comes from a unique email address entered in the From field.

8. Click Update.

Specify an outbound email address for a particular language
You can specify a different email address for each language your instance supports.

Role required: admin

1. Create or copy a notification record for the desired event.

2. In the What will it contain section, enter a new email address in the From field.

3. Create the Subject and Message content in the desired language.

4. In the When to send section, create a condition as follows:
   a. In the list of Condition fields, select Show Related Fields from the bottom of the choice list.
   b. From the choice list of Related Fields, select the field that identifies the recipient.
      For example, select Caller > User fields to send the notification to the user who called in an incident, or Assigned to > User fields to send the notification to the user to whom an incident is assigned.
   c. From the choice list of user fields, select Language.
   d. Select the is operator.
   e. Complete the condition by selecting the language of the desired user.

5. Click Update.

   All notifications for that event originate from the specified email address and go out in the language of the recipient.

Notification variables
Use notification variables to display dynamic information in the body of a notification such as a field value, a link to a record, or a link to system preferences.

Syntax

Specify a notification variable using this syntax:

```
${variable-name+variable-parameters}
```

The variable-name portion is always required. Not all notification variables support the variable-parameters portion. When available, most variable parameters are optional. See the list of available notification variables for variable names and available parameters.
**Available variables**

The system provides these notification variables.

### Available notification variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Available parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>${field-name}</td>
<td>Display the value of the specified field.</td>
<td>None</td>
</tr>
<tr>
<td>${image-field-name}</td>
<td>Display an image associated with a record. This variable is typically used</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>with HTML to specify the source of an image element.</td>
<td></td>
</tr>
<tr>
<td>• ${URI}</td>
<td>Display a link to the current record.</td>
<td>Any valid <strong>sysparm</strong> URL</td>
</tr>
<tr>
<td>• ${URI_REF}</td>
<td>• <strong>URI</strong>: The link text is the word <strong>LINK</strong>.</td>
<td>parameter. For example:</td>
</tr>
<tr>
<td></td>
<td>• <strong>URL_REF</strong>: The link text is the display value of the record.</td>
<td>• <strong>sysparm_scriptlet</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>sysparm_view</strong></td>
</tr>
<tr>
<td>${reference-field.URI}</td>
<td>Display a link to the record listed in a reference field.</td>
<td>Any valid <strong>sysparm</strong> URL</td>
</tr>
<tr>
<td>• ${reference-field.URI_REF}</td>
<td>• <strong>URI</strong>: The link text is the word <strong>LINK</strong>.</td>
<td>parameter. For example:</td>
</tr>
<tr>
<td></td>
<td>• <strong>URL_REF</strong>: The link text is the display value of the record.</td>
<td>• <strong>sysparm_scriptlet</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>sysparm_view</strong></td>
</tr>
<tr>
<td>${CMS_URI}</td>
<td>Display a link to the specified record within a CMS page.</td>
<td><code>&lt;CMS-site&gt;/&lt;CMS-page&gt;</code>: The</td>
</tr>
<tr>
<td></td>
<td></td>
<td>required relative path to the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CMS page.</td>
</tr>
<tr>
<td>${notification:body}</td>
<td>Display the body contents of an email template or email notification.</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Use this notification variable to specify where to display body content in</td>
<td></td>
</tr>
<tr>
<td></td>
<td>an email layout.</td>
<td></td>
</tr>
<tr>
<td>${mail_script:script-name}</td>
<td>Run the specified mail script.</td>
<td>None</td>
</tr>
<tr>
<td>${NOTIF_UNSUB}</td>
<td>Display a link unsubscribe from this notification.</td>
<td><strong>link_text</strong>: specify the text</td>
</tr>
<tr>
<td></td>
<td></td>
<td>to display as a link within</td>
</tr>
<tr>
<td></td>
<td></td>
<td>quotation marks.</td>
</tr>
<tr>
<td>${NOTIF_PREFS}</td>
<td>Display a link to set notification preferences.</td>
<td><strong>link_text</strong>: specify the text</td>
</tr>
<tr>
<td></td>
<td></td>
<td>to display as a link within</td>
</tr>
<tr>
<td></td>
<td></td>
<td>quotation marks.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
<td>Available parameters</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>$(comments:n)$</td>
<td>Display the most recent comments that were made on the target record. The number of comments to display is $n$. For example, $(comments:3)$ displays the last three comments that were made to the record. To display all comments, use the variable $(comments)$.</td>
<td>Any number greater than 0.</td>
</tr>
<tr>
<td>$(comments_and_work_notes:n)$</td>
<td>Display the most recent comments and work notes that were made on the target record. The number of comments and work notes to display is $n$. For example, $(comments_and_work_notes:3)$ displays the last three comments and work notes that were made to the record. To display all comments and work notes, use the variable $(comments_and_work_notes)$.</td>
<td>Any number greater than 0.</td>
</tr>
</tbody>
</table>

**Examples**

Refer to the following examples to see how each notification variable is rendered in the output:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Example</th>
</tr>
</thead>
</table>
| $(field-name)$ | Source: Incident ${number} - comments added  
Output: Incident INC1000001 - comments added |
<table>
<thead>
<tr>
<th>Variable</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>${image-field-name}</td>
<td>Source: <code>&lt;img src='${picture}?t=medium'/&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Output:</td>
</tr>
<tr>
<td></td>
<td><img src="image-field-name" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td>• ${URI}</td>
</tr>
<tr>
<td></td>
<td>• ${URI_REF}</td>
</tr>
<tr>
<td></td>
<td>${URI} Source: <a href="URI">Click here to view incident: ${URI}</a></td>
</tr>
<tr>
<td></td>
<td>${URI} Output:</td>
</tr>
<tr>
<td></td>
<td><img src="URI" alt="URI" /></td>
</tr>
<tr>
<td></td>
<td>• ${reference-field.URI}</td>
</tr>
<tr>
<td></td>
<td>• ${reference-field.URI_REF}</td>
</tr>
<tr>
<td></td>
<td>Source: <a href="URI_REF">Click here to view Incident: ${URI_REF}</a></td>
</tr>
<tr>
<td></td>
<td>Click here to view Related Problem: <a href="PRB0040001">PRB0040001</a></td>
</tr>
<tr>
<td>Variable</td>
<td>Example</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>$(CMS_URI)</td>
<td>Source: ${CMS_URI+ess/incident_detail} Output: a link to a target CMS page such as https://&lt;instance name&gt;.service-now.com/ess/incident_detail.do?sysparm_document_key=incident,46e18c0fa9fe19810066a0083f76bd56</td>
</tr>
<tr>
<td>Variable</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>${notification:body}</code></td>
<td></td>
</tr>
<tr>
<td><code>${mail_script:script-name}</code></td>
<td></td>
</tr>
<tr>
<td><code>${NOTIF_UNSUB}</code></td>
<td></td>
</tr>
<tr>
<td><code>${NOTIF_PREFS}</code></td>
<td></td>
</tr>
</tbody>
</table>

![Example Diagram](image-url)
Links to records in email notifications

Adding the `$URI` parameter to an outbound email body or template creates a link to a specific record.

When a user clicks the word LINK, the instance prompts the user to log in if not already logged in, and then redirects the user to the record specified in the URI.

Link displayed by `$URI` parameter

The `$URI` parameter has an extension called the `$URI+` format to specify additional arguments in the email link, such as sysparm terms, in addition to the automatically created URI. For example (whitespace added for improved readability):

```
$URI+&sysparm_scriptlet=current.assigned_to=gs.getUserID()
&sysparm_scriptlet_condition=current.assigned_to.nil()
&sysparm_view=incident_active
```

This example executes the JavaScript:

```
current.assigned_to=gs.getUserID()
```

when the condition of

```
current.assigned_to.nil()
```

is satisfied. Additionally, the script sets the view to `incident_active`.

Linking to a record in Workspace

The `$URI` and `$URI_REF` variables don't apply to records in Workspace. To link to a record in Workspace, create a mail script and reference it in your notification. For more information on using mail scripts, see JavaScript in emails.

The mail script that you create should print a URL to the notification. The URL must have the following format:

```
https://<instance_name>/now/workspace/<workspace_name>/record/<table_name>/<sys_id>
```

The following example script shows the logic that a mail script must include to create a link to a record in Workspace.

```
// Dynamically construct an Agent Workspace URL and insert a link in the notification
var agentURL = '<a href="' + gs.getProperty('glide.servlet.uri') + '/now/workspace/agent/record/' + current.getTableName() + '/' + current.sys_id + '">' + current.number + '</a>';
template.print(agentURL + '<br />');
```

Enable links to records
Adding the special `{URI}` parameter to an outbound email body or template creates a link to a specific record.

When a user clicks the word **LINK**, the instance prompts the user to log in if not already logged in, and then redirects the user to the record specified in the URI.

---

**Short description:** SAP Sales app is not accessible

**Click here to view incident:** LINK

---

**Comments:**

---

**URI email notification**

The `{URI}` parameter has an extension called the `{URI+}` format to specify additional arguments in the email link, such as sysparm terms, in addition to the automatically created URI. For example (whitespace added for improved readability):

```
$(URI+&sysparm_scriptlet=current.assigned_to(gs.getUserID())
&sysparm_scriptlet_condition=current.assigned_to.nil()
&sysparm_view=incident_active)
```

This example executes the JavaScript:

```
current.assigned_to=gs.getUserID()
```

when the condition of

```
current.assigned_to.nil()
```

is satisfied. Additionally, the script sets the view to **incident_active**.

---

**Change the link text**

To show the display value of the record as the link text instead of the word **LINK**, use the `{URI_REF}` parameter instead of the `{URI}` parameter.

---

**Short description:** SAP Sales app is not accessible

**Click here to view incident:** INC0000055

---

**Comments:**

---

**URI_REF email notification**

For example, if the URL displays an incident record, the link text is the incident number, which is the display value for incidents. If the URL displays a user record, then the link text is the user name.

---

**Link to related records**

A notification can link to a related record by specifying a reference field in front of the `{URI}` or `{URI_REF}` parameters.

Format the related record link as follows:
• \${<reference field that contains the related record you want to display>.URI}
• \${<reference field that contains the related record you want to display>.URI_REF}

For example:

<table>
<thead>
<tr>
<th>Related record to provide link to</th>
<th>Notification record table</th>
<th>Reference field</th>
<th>Samples</th>
</tr>
</thead>
</table>
| Related task record to be approved from an approval notification | Approval [sysapproval_approver] | Approval for [sysapproval] | • \${sysapproval.URI}
• \${sysapproval.URI_REF} |
| Related problem record in an incident notification | Incident | Problem [problem_id] | • \${problem_id.URI}
• \${problem_id.URI_REF} |

For example, the following notification template produces the email links in the picture below:

Click here to view Incident: \${URI_REF}
Click here to view Related Problem: \${problem_id.URI_REF}

Click here to view Incident: INC0010002
Click here to view Related Problem: PRB0040001

Content page links in email notifications
Links to CMS pages can be put in notifications to make it easy for the reader to access the pages.

The link takes the following format: \${CMS_URI+<site>/<page>}.  

For example, to link the email recipient to a page called Incident in the content site ESS, with the current incident as the target document, use the following format: \${CMS_URI+ess/incident_detail}

The resulting email URL has this format: https://<instance name>.service-now.com/ess/incident_detail.do?sysparm_document_key=incident,46e18c0fa9fe19810066a0083f76bd56

Email unsubscribe
Administrators can add unsubscribe links to notifications so that users can stop receiving particular email messages.

**Note:** The base system notifications include unsubscribe and notification preferences links.

The system offers two types of macros to create unsubscribe links.

• An unsubscribe link that creates an email message to the instance.
• An unsubscribe link that opens the notification preferences for the user on the instance.
Available unsubscribe macros

<table>
<thead>
<tr>
<th>Unsubscribe type</th>
<th>Macro used</th>
<th>Description</th>
<th>Available parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsubscribe by email (Unauthenticated)</td>
<td>${NOTIF_UNSUB}</td>
<td>The system generates an HTML mailto hyperlink. When users click the link, their browser or email client creates a pre-formatted unsubscribe email message to the instance.</td>
<td>link_text: specify the text to display as a link within quotation marks.</td>
</tr>
<tr>
<td>Unsubscribe by notification preferences (Authenticated)</td>
<td>${NOTIF_PREFS}</td>
<td>The system generates an instance link directly to the notification preferences for this notification type.</td>
<td>link_text: specify the text to display as a link within quotation marks.</td>
</tr>
</tbody>
</table>

Administrators can add unsubscribe macros to any notification record type such as:
- Email layouts
- Email templates
- Email notifications

Unsubscribe by email

Unsubscribe by email requires the user email client or browser to create a pre-formatted email message containing these elements:
- The To field has the email address of the instance.
- The Subject starts with the string Unsubscribe from.
- The Body has a JSON string with a name-value pair of Unsubscribe and an array value that contains two more name-value pairs.
  - The notification_id parameter specifies the Sys ID of the notification the user wants to unsubscribe from.
  - The unsub_token parameter specifies an instance ID the system uses to verify that the email came from a ServiceNow instance.

Note: Some email clients and web browsers, such as GMail on Chrome, require extra client configuration to support mailto hyperlinks. Administrators can provide an alternative unsubscribe method for users whose email client or browser does not support mailto links. See RFC6068 for information about the mailto URI scheme.

The Unsubscribe from Notification inbound action processes the email and unsubscribes the sender from the listed notification.

Note: Unsubscribing by email message does not require users to authenticate with the instance first.
Unsubscribe by notification preferences

Unsubscribe by notification preferences requires the user's browser to navigate to the notification preferences page on the instance. After logging in, the system displays the notification preferences for this particular notification.

Users can set preferences for this notification such as disabling notifications for a particular device. Users must save their notification preferences for changes to take effect.

Unsubscribe links

This email layout adds several unsubscribe links to the bottom of each email notification.

$\text{(NOTIF_UNSUB)}$ from this notification by email or $\text{(NOTIF_UNSUB +link_text="click here")}$.

Manage your $\text{(NOTIF_PREFS)}$ or $\text{(NOTIF_PREFS+link_text="click here")}$.  

When rendered in an email notification, the unsubscribe links only display the link text.
Preview records for this breakdown source

Event Creator | Preview Record
-----|-----
Fred Luddy | INC0000060

Users
Beth Anglin

Subject
Incident INC0000060 commented

Body

You can view all the details of the incident by following the link below:

Go to Instance

Unsubscribe | Manage Preferences
If a user clicks the **Unsubscribe** link, the email client creates a message such as this:

![Unsubscribe email message](image)

---

**Sample unsubscribe by email message**

*Scripting for email notifications*

Email scripts allow for business rule-like scripting within an outbound email message.

With mail scripts, you can dynamically change the email output of your system based on different criteria. Mail scripts allow you to perform simple tasks, such as displaying incident data, and complex ones, such as making advanced database queries.

You can add a `${mail_script:script name}` embedded script tag to the body of the email notification or template, replacing `script name` with the name of the script you created. This makes it easy to use the same scripts in multiple email notifications or templates.

If you manually enter a mail script bounded by `<mail_script>` and `</mail_script>` in the body of a new or converted email notification or template, and then attempt to save the record, a message asks whether the mail script should be converted. In many cases, an unconverted mail script fails to run from inside the HTML editor. If you select **Yes**, the script is added to the Email Script [sys_script_email] table and is automatically replaced in the body with an embedded script tag (${mail_script:script_name}).

**JavaScript in emails**

Create mail scripts in **System Notifications > Email > Notification Email Script**, and refer to them by using `${mail_script:script name}` in the script field.

To print text into the body of the message, use the `template.print("a string")` function.
JavaScript in templates

The event.parm1 and event.parm2 parameters that come from the originating event can also be used.

Mail script API

Certain variables are available when processing mail_script scripts.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Object Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>template</td>
<td>Handles printing from the mail script to the email message.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>template.print(&quot;message&quot;);</code> //outputs message to the email body.</td>
</tr>
<tr>
<td></td>
<td><code>template.space(&quot;number of spaces&quot;);</code> //outputs spaces to the email body.</td>
</tr>
<tr>
<td>email_action</td>
<td>GlideRecord object for the email notification (sysevent_email_action).</td>
</tr>
<tr>
<td>event</td>
<td>GlideRecord object for the event that fired the notification (sysevent).</td>
</tr>
<tr>
<td>Variable</td>
<td>Object Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------</td>
</tr>
<tr>
<td>email</td>
<td>EmailOutbound object</td>
</tr>
</tbody>
</table>

Available methods:
- `addAddress(String type, String address, String displayname):` type can be cc or bcc.
- `setFrom(String address):` override the sender address.
- `setReplyTo(String address):` override the reply to address.
- `setSubject(String subject):` override the subject of the message.
- `setBody(String message):` override the body of the message.

The email address that is passed by `setFrom` and `setReplyTo` needs to be in a valid form such as helpdesk@sn.com or Display Name <helpdesk@sn.com>. If the email address includes a 'Display Name', then that value overrides the instance’s display name.

Example scripting for email notifications

Examples of scripting for email notifications.

**Scripting examples for email notifications**

A simple text string is the most basic example of the way a mail script works. This script prints out "Incident number - INC00001":

```java
template.print("Incident number - "+ current.number);
```

More advanced scripts, like this one, can be found by browsing through the base system email templates.

```java
template.print("Summary of Requested items:<br />
var now_GR = new GlideRecord("sc_req_item");
now_GR.addQuery("request", current.sysapproval);
now_GR.query();
while(now_GR.next()) {
    template.print(now_GR.number + ":  " + now_GR.quantity + " X " +
    now_GR.cat_item.getDisplayValue()
    + " at " + now_GR.cat_item.price.getDisplayValue() + "
    each <br />
}
```

To dynamically change field values within an email, use the following functions within `<mail_script>` syntax:

```java
... email.setFrom(current.caller_id.email);
email.setReplyTo("joe.employee@yourcompany.com");
email.setSubject("This is the new subject line");
email.setBody("This is the new body");
```
Using the instance_name property ensures that the notification still works when migrated between instances.

```javascript
function dothis(){
    var now_GR = new GlideRecord('sys_attachment');
    now_GR.addQuery('table_sys_id', current.sys_id);
    now_GR.query();
    while(now_GR.next()){
        template.print('Attachment: <a href="https://'+
            gs.getProperty('instance_name')+'.'
            +service-now.com/sys_attachment.do?sys_id='+ now_GR.sys_id+'">'+
            now_GR.file_name+'</a>');}
}
```

You can specify copied and blind copied recipients by using the email object within a mail script.

```javascript
//email.addAddress(type, address, displayname);
email.addAddress("cc","john.copy@example.com","John Roberts");
email.addAddress("bcc","john.secret@example.com","John Roberts");
```

The following is an example script to add users from watch_list as copied recipients.

```javascript
if(!current.watch_list.nil()){ //get watch list addresses and add to cc
    var watcherIds = current.watch_list.split("","");

     //get user records
    var user = new GlideRecord("sys_user");
    user.addQuery("sys_id", watcherIds);
    user.addQuery("notification",2);
    //email
    user.addQuery("email","!=","”);
    user.query();

    while(user.next()){
        //add to cc list
        email.addAddress("cc", user.email, user.getDisplayValue());}
}
```

### Useful attachment scripts

This is a searchable version of the Useful Attachment Scripts.

**Caution:** The customization described here was developed for use in specific instances, and is not supported by ServiceNow Technical Support. This method is provided as-is and should be tested thoroughly before implementation. Post all questions and comments regarding this customization to our community forum.

### Copy attachments from record to record

Use the following script to copy an attachment from one record to another record:

```javascript
GlideSysAttachment.copy('sourcetable','sys_id','destinationtable','sys_id');
```

**Note:** GlideSysAttachment.copy copies all attachments; it cannot select specific attachments.
Delete duplicate attachments

Use the following script in a business rule, scheduled job, or background script to delete duplicate attachments located in the Attachments [sys_attachment] table:

```javascript
function fixDuplicateImages(){var now_GR =new GlideRecord('sys_attachment');
  now_GR.addQuery('table_name','LIKE','ZZ_YY%');
  now_GR.orderBy('table_sys_id');
  now_GR.orderByDesc('sys_created_on');
  now_GR.query();var lastID = 'not_a_match';var lastFile
  = 'not_a_match';while(now_GR.next()){var isDuplicate = (lastID ==
  now_GR.table_sys_id)&& (lastFile == now_GR.file_name);
    lastID = now_GR.table_sys_id;
    lastFile = now_GR.file_name;
    gs.print(now_GR.table_sys_id+' '+ now_GR.table_name
    + ' '+ now_GR.file_name+' '+ now_GR.sys_created_on+' '+
    isDuplicate);
    if(isDuplicate)
      now_GR.deleteRecord();}
}
```

Display whether tasks have attachments in list view

Use the following script in a business rule to display whether tasks have attachments when viewed in the record list view. Note that the script needs a custom field on the Has Attachments [u_has_attachments] table:

```javascript
function checkAttachment(){// if inserting then the task has an
  attachmentif(current.operation()=='insert'){
    hasAttachment('true'); // if deleting attachment check for
  other attachmentsif(current.operation()=='delete'){
    var timeNow3 =new GlideDateTime();
    gs.log('has_attachment br: gliderecord query start date time
    is: '+ timeNow3.getNumericValue(),'jwtest');var attachCount =new
    GlideAggregate('sys_attachment');
    attachCount.addQuery('table_sys_id',current.sys_id);
    attachCount.addAggregate('COUNT');
    attachCount.query();
    var numAttachments = 0; // if no other attachments task does not
  have attachmentif(attachCount.next()){numAttachments =
    attachCount.getAggregate("COUNT");if(numAttachments >0){
      hasAttachment = 'true';}else{
      hasAttachment = 'false';}
    var timeNow4 = new GlideDateTime();
    gs.log('has_attachment br: gliderecord query start date time is: '+
    timeNow4.getNumericValue(),'jwtest');}
  function hasAttachment(answer){var task =new GlideRecord('task');
    task.addQuery('sys_id',current.table_sys_id);
    task.query();
    if(task.next()){
      task.u_has_attachment = answer;
      task.autoSysFields(false); // Don't set the lastUpdatedTime or the
  Simultaneous Update Alert will likely get triggered
```
task.setWorkflow(false);//Don't allow other business rules to run, otherwise multiple notifications will likely be sent
    task.update();}}

Note: Schedule the business rule to run after insert/delete.

Link to attachments in an email notification

Use the following script in an email notification or template to include links to attachments:

    printattachments();

    function printattachments(){var now_GR =new GlideRecord('sys_attachment');
    now_GR.addQuery('table_sys_id',current.sys_id);
    now_GR.query();while(now_GR.next()){
        template.print('Attachment: <a href="http://' + gs.getProperty("instance_name") + '.service-now.com/sys_attachment.do?sys_id=' + now_GR.sys_id +">' + now_GR.file_name + '</a>');}}

Note: Replace "instance_name" with your instance name.

Attachment Logging

Whenever a user downloads an attachment, the action writes an attachment.read event record to the event log. If desired, you can process these events with a Script Action or an Email Notification. This can be useful if you want to do something when an attachment is read. For example, you can record when and by whom certain attachments are downloaded. For this functionality, the current variable must point to a sys_attachment record, and the event record must use the following parameters:

- parm1: File name
- parm2: Table name

Baseline email notifications

The baseline system provides several email notifications.

Some events listed in this table do not appear in a business rule and are fired by other conditions in the platform. Some events are hardcoded and are not user configurable.

### Baseline email notification descriptions

<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
<th>Triggering event</th>
<th>Business Rule Controlling Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appointment Invite</td>
<td>Type: Meeting Invitation</td>
<td>itil_appointment.inserted</td>
<td>Global business rule</td>
</tr>
<tr>
<td></td>
<td>Adds a meeting invitation</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>to the recipient's calendar</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>by sending an iCalendar formatted email</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email notification</td>
<td>Description</td>
<td>Triggering event</td>
<td>Business Rule Controlling Event</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------</td>
<td>---------------------------------</td>
</tr>
</tbody>
</table>
| Appointment Update       | Type: Meeting Invitation
Updates an existing meeting in the recipient’s calendar by sending an iCalendar formatted email | itil_appointment.updated   | Global business rule            |
| Approval Rejected        | Type: EMAIL
A task-based approval has been rejected – includes the approver’s name. | approval.rejected          | approver events                 |
| Approval Rejected by Other | Type: EMAIL
A task-based approval has been rejected – includes the approver’s name. | approval.rejected.by.other | approval events                 |
| Approval Request         | Type: EMAIL
Sends an email for the recipient to reply with an approval decision. In the approval email, the recipient selects a link that builds the appropriate reply email. These emails come only from task-based approvals. | approval.inserted          | approver changes                |
| Catalog Approval Rejected | Type: EMAIL
A catalog request has been rejected – includes the approver’s name. | request.approval.rejected  | approval events                 |
| Catalog Approval Request | Type: EMAIL
A catalog request for which you were an approver has been cancelled. | request.approval.cancelled | approver changes                |
| Catalog Approval Request | Type: EMAIL
A catalog request for which you are an approver has been made. | request.approval.inserted  | approval events                 |
| Certificate Expired      | Type: EMAIL
Notification that the X.509 certificate has expired. | certificate.expired        | certificate events              |
<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
<th>Triggering event</th>
<th>Business Rule Controlling Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate Expiring</td>
<td>Type: EMAIL&lt;br&gt;Notification that the X.509 certificate is expiring in N days.</td>
<td>certificate.expiring</td>
<td>certificate events</td>
</tr>
<tr>
<td>Change approved</td>
<td>Type: EMAIL&lt;br&gt;A change request has been approved.</td>
<td>change.approved</td>
<td>Change events and task events</td>
</tr>
<tr>
<td>Change assigned to me</td>
<td>Type: EMAIL&lt;br&gt;A change request has been assigned to you.</td>
<td>change.assigned</td>
<td>Change events</td>
</tr>
<tr>
<td>Change assigned to my group</td>
<td>Type: EMAIL&lt;br&gt;A change request has been assigned to your group.</td>
<td>change.assigned.to.group</td>
<td>Change events</td>
</tr>
<tr>
<td>Change commented (to assignee)</td>
<td>Type: EMAIL&lt;br&gt;A comment has been added to a change request. The person assigned to the change request receives an email notification.</td>
<td>change.commented</td>
<td>Change events</td>
</tr>
<tr>
<td>Change commented (unassigned)</td>
<td>Type: EMAIL&lt;br&gt;A comment has been added to a change request. The assignment group assigned to the change request receives an email notification.</td>
<td>change.commented</td>
<td>Change events</td>
</tr>
<tr>
<td>Change Notification</td>
<td>Type: EMAIL&lt;br&gt;Notification of a change in the fields label in a form.</td>
<td>label.notify</td>
<td></td>
</tr>
<tr>
<td>Change rejected</td>
<td>Type: EMAIL&lt;br&gt;A change request has been rejected.</td>
<td>change.rejected</td>
<td>Change events and task events</td>
</tr>
<tr>
<td>Change Task worknoted (unassigned)</td>
<td>Type: EMAIL&lt;br&gt;A work note has been added to a change task. The assignment group assigned to the change task receives an email notification.</td>
<td>change_task.worknoted</td>
<td>Change task events</td>
</tr>
<tr>
<td>Email notification</td>
<td>Description</td>
<td>Triggering event</td>
<td>Business Rule Controlling Event</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------</td>
<td>---------------------------------</td>
</tr>
</tbody>
</table>
| Change Task worknoted (to assignee)      | Type: EMAIL
A work note has been added to a change task. The person assigned to the change task receives an email notification. | change_task.worknoted     | Change task events              |
| Change Task assigned to my group          | Type: EMAIL
A change task has been assigned to your group. | change_task.assigned.to.group | Change task events              |
| Change Task assigned to me                | Type: EMAIL
A change task has been assigned to you. | change_task.assigned       | Change task events              |
| Change worknoted (to assignee)           | Type: EMAIL
A work note has been added to a change request. The person assigned to the change request receives an email notification. | change.worknoted           | Change events                   |
| Change worknoted (unassigned)            | Type: EMAIL
A work note has been added to a change request. The assignment group assigned to the change request receives an email notification. | change.worknoted           | Change events                   |
| Email assigned to                        | Type: EMAIL
An incident has been assigned to you (the recipient of the email). | incident.assigned          | incident.events                 |
<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
<th>Triggering event</th>
<th>Business Rule Controlling Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email assigned to (sc_task)</td>
<td>Type: EMAIL</td>
<td>sc_task_assigned_to_user</td>
<td>sc_task_events</td>
</tr>
<tr>
<td></td>
<td>A task has been assigned to you (the recipient of the email).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This email notification was used for the legacy Delivery Plan system of email notifications. In order to use this email notification with a workflow, the <code>work_start</code> field needs to be set by the workflow using a Set Value activity.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email assigned to group (sc_task)</td>
<td>Type: EMAIL</td>
<td>sc_task_assigned_to_group</td>
<td>sc_task_events</td>
</tr>
<tr>
<td></td>
<td>A Service Catalog task has been assigned to an assignment group of which you are a member (the recipient of the email).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Incident Closed</td>
<td>Type: EMAIL</td>
<td>incident_updated</td>
<td>incident_events</td>
</tr>
<tr>
<td></td>
<td>An incident opened by you (the recipient of the email), has been closed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Incident Commented</td>
<td>Type: EMAIL</td>
<td>incident_commented</td>
<td>incident_events</td>
</tr>
<tr>
<td></td>
<td>An incident opened by you (the recipient of the email) has had comments added. This notification uses a template for an employee self-service (ESS) user.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
<th>Triggering event</th>
<th>Business Rule Controlling Event</th>
</tr>
</thead>
</table>
| Incident Commented                 | Type: EMAIL
An incident assigned to you (the recipient of the email) has had comments added. This notification uses a template for an ITIL user. | incidentCommented         | incident events               |
| Incident Opened                    | Type: EMAIL
An incident has been opened for you (the recipient of the email) by someone else. This notification uses a template for an employee self-service (ESS) user. | incidentInserted          | incident events               |
| Incident Opened & Unassigned       | Type: EMAIL
An incident has been opened and is unassigned. This notification uses a template for an ITIL user. | incidentInserted          | incident events               |
| Incident Resolved                  | Type: EMAIL
An incident opened by you has been resolved, and feedback is required to determine if the incident should be closed. | incidentUpdated           | incident events               |
| Knowledge Closed Created           | Type: EMAIL
A contributor's submission to the Knowledge Base was accepted and an article was created. | kbSubmissionClosedCreated | KB event                     |
| Knowledge Closed Duplicate         | Type: EMAIL
A contributor's submission to the Knowledge Base was determined to be a duplicate, and no article was created. | kbSubmissionClosedDuplicate | KB event                     |
| Knowledge Closed Invalid           | Type: EMAIL
A contributor's submission to the Knowledge Base was determined to be invalid ( unusable). | kbSubmissionClosedInvalid | KB event                     |
<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
<th>Triggering event</th>
<th>Business Rule Controlling Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify Change Calendar</td>
<td>Type: Meeting Invitation</td>
<td>change.calendar.notify</td>
<td>change events</td>
</tr>
<tr>
<td></td>
<td>Notifies the recipients of the schedule for a change request and exports the schedule to the Microsoft Outlook calendar. The email is in the format of iCalendar formatted email.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notify Change Calendar Remove</td>
<td>Type: Meeting Invitation</td>
<td>change.calendar.notify.remove</td>
<td>change events</td>
</tr>
<tr>
<td></td>
<td>Notifies the recipients that a scheduled change has been closed or assigned to someone else and removes the entry from the Microsoft Outlook calendar. The email is in the format of iCalendar formatted email.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Task assigned to me</td>
<td>Type: EMAIL</td>
<td>problem_task.assigned</td>
<td>Problem task events</td>
</tr>
<tr>
<td></td>
<td>A problem task has been assigned to you.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Task assigned to my group</td>
<td>Type: EMAIL</td>
<td>problem_task.assigned.to.group</td>
<td>Problem task events</td>
</tr>
<tr>
<td></td>
<td>A problem task has been assigned to your group.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Task worknoted (to assignee)</td>
<td>Type: EMAIL</td>
<td>problem_task.worknoted</td>
<td>Problem task events</td>
</tr>
<tr>
<td></td>
<td>A work note has been added to a problem task. The person assigned to the problem task receives an email notification.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Task worknoted (unassigned)</td>
<td>Type: EMAIL</td>
<td>problem_task.worknoted</td>
<td>Problem task events</td>
</tr>
<tr>
<td></td>
<td>A work note has been added to a problem task. The assignment group assigned to the problem task receives an email notification.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem worknoted (to assignee)</td>
<td>Type: EMAIL</td>
<td>problem.worknoted</td>
<td>Problem events</td>
</tr>
<tr>
<td></td>
<td>A work note has been added to a problem. The person assigned to the problem receives an email notification.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email notification</td>
<td>Description</td>
<td>Triggering event</td>
<td>Business Rule Controlling Event</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Problem worknoted (unassigned)</td>
<td>Type: EMAIL A work note has been added to a problem. The assignment group assigned to the problem receives an email notification.</td>
<td>problem.worknoted</td>
<td>Problem events</td>
</tr>
<tr>
<td>Reminder Insert</td>
<td>Type: Meeting Invitation Creates a calendar reminder regarding an open task. The email is in the format of iCalendar formatted email.</td>
<td>reminder.notify</td>
<td></td>
</tr>
<tr>
<td>Reminder Insert</td>
<td>Type: Meeting Invitation A task has been closed or deleted. This notification removes the task reminder from Outlook. The email is in the format of iCalendar formatted email.</td>
<td>reminder.notify.delete</td>
<td></td>
</tr>
<tr>
<td>Reminder Insert Email</td>
<td>Type: EMAIL Sends the recipient a reminder email about a specific task.</td>
<td>reminder.notify.email</td>
<td></td>
</tr>
<tr>
<td>Request Approved</td>
<td>Type: EMAIL A Service Catalog request, opened by the recipient, has been approved.</td>
<td>sc_request.approved</td>
<td>sc_request events</td>
</tr>
<tr>
<td>Request Assigned</td>
<td>Type: EMAIL A Service Catalog request has been assigned to the recipient.</td>
<td>sc_request.assigned</td>
<td>sc_request events</td>
</tr>
<tr>
<td>Request Completed</td>
<td>Type: EMAIL A Service Catalog request, opened by the recipient, has been completed.</td>
<td>sc_request.updated</td>
<td>sc_request events</td>
</tr>
<tr>
<td>Email notification</td>
<td>Description</td>
<td>Triggering event</td>
<td>Business Rule Controlling Event</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Request Item Assigned</td>
<td>Type: EMAIL</td>
<td>sc_req_item.assigned</td>
<td>sc_request events</td>
</tr>
<tr>
<td></td>
<td>An item requested from the Service Catalog has been assigned to you.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request Item Delivery</td>
<td>Type: EMAIL</td>
<td>sc_req_item.delivery</td>
<td>sc_request events</td>
</tr>
<tr>
<td></td>
<td>An item requested from the Service Catalog by the recipient is being delivered.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request Opened on Behalf</td>
<td>Type: EMAIL</td>
<td>sc_request.requested_for</td>
<td>sc_request events</td>
</tr>
<tr>
<td></td>
<td>A Service Catalog request has been opened on behalf of the recipient.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset Password</td>
<td>Type: EMAIL</td>
<td>reset.password</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The recipient’s password has been reset as requested.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scheduled Import Completed</td>
<td>Type: EMAIL</td>
<td>scheduled_import_set.completed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A scheduled import set has completed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Upgraded</td>
<td>Type: EMAIL</td>
<td>system.upgraded</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The recipient’s system has been upgraded.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task approved</td>
<td>Type: EMAIL</td>
<td>task.approved</td>
<td>Change events and task events</td>
</tr>
<tr>
<td></td>
<td>An ITIL task has been approved.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text Index Completed</td>
<td>Type: EMAIL</td>
<td>text_index.complete</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A scheduled system index has completed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unscheduled Change</td>
<td>Type: EMAIL</td>
<td>cmdb.unscheduled.change</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A named configuration item has changed, and no active change request exists.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notification example: notify an assignment group of updates to Priority 1 Incidents
Notify users by email when there are updates to high priority incidents.
Role required: admin
Send emails to an assignment group whenever there are updates to an incident in which the **Priority** is 1 - **Critical**. Include information that is of interest to the recipients, such as the incident number, category, assignees, and any comments that were added to the incident.

1. Navigate to **System Notification > Email > Notifications**, and then click **New**.
2. On the email notification form, enter the following values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Priority 1 Incident Updated</td>
</tr>
<tr>
<td>Table</td>
<td>Incident [incident]</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
<tr>
<td>Category</td>
<td>Incident Alert</td>
</tr>
<tr>
<td>Send when</td>
<td>Record inserted or updated</td>
</tr>
<tr>
<td>Inserted</td>
<td>Selected</td>
</tr>
<tr>
<td>Updated</td>
<td>Selected</td>
</tr>
<tr>
<td>Conditions</td>
<td>[Priority][is][1 - Critical] AND [Updated][changes]</td>
</tr>
<tr>
<td>Users/Groups in fields</td>
<td>Assignment group</td>
</tr>
<tr>
<td>Subject</td>
<td>Priority ${priority} Incident updated</td>
</tr>
</tbody>
</table>

**Note:** In this notification, the variable ${priority} returns the value **1 - Critical**.

3. In the **Message HTML** field, enter the following message and script:

```
Short Description: ${short_description}
Click here to view incident: ${URI}
Incident number: ${number}
Category: ${category}
Assigned to: ${assigned_to}
Assignment group: ${assignment_group}
<hr/>
Comments: ${comments}
```

4. From the form context menu, click **Save**.
5. Preview the email notification to ensure it includes all the needed information.
   a) On the notifications form, click **Preview Notification**.
   b) Note that the email includes the following information:
      - Short description
      - A link to the incident record
      - Incident number
      - Category
      - The name of the user to whom the incident is assigned
      - The group assigned to the incident
      - Comments from the incident record
6. Test that the email notification sends to an assignment group when its Priority 1 Incident is updated.
   a) Create a user who has an email address that you can monitor, and then create a group that includes the user that you created.
   b) Navigate to Incident > Open, and then open an incident in which the Priority is 1 - Critical.
   c) In the Assignment group field, enter the group that you created.
   d) From the form context menu, click Save.
   e) Add comments to the form to update the incident, and then click Update.
   f) Check the email account of the user member in the assignment group.

Notification example: notify task assignees
Notify users who are assigned a Task [task] record.
Role required: admin
Set up your email as a test email address. Navigate to System Properties > Email Properties, and then enter your email address under Send all email to this test email address.

1. Navigate to System Notification > Email > Notifications, and then click New.
2. On the form, enter the following values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Task Assigned</td>
</tr>
<tr>
<td>Table</td>
<td>Task [task]</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
<tr>
<td>Category</td>
<td>Uncategorized</td>
</tr>
<tr>
<td>Send when</td>
<td>Record inserted or updated</td>
</tr>
<tr>
<td>Inserted</td>
<td>Selected</td>
</tr>
<tr>
<td>Updated</td>
<td>Selected</td>
</tr>
<tr>
<td>Conditions</td>
<td>[Assigned to][changes]</td>
</tr>
<tr>
<td>Users/Groups in fields</td>
<td>Assigned to</td>
</tr>
<tr>
<td>Subject</td>
<td>Task Assigned</td>
</tr>
</tbody>
</table>

3. In the Message HTML field, add a message to send to whomever the task is assigned to.
4. From the form context menu, click Save.
5. To see a mock version of the system email that you created, click Preview Notification on the notification form.
6. Test the notification sends to a task assignee.
   a) Assign some task records.
   b) Check your email for assignment notifications.

Email templates
Email templates enable administrators to create reusable content for the subject line and message body of email notifications.

Templates deliver consistent information on specific system activities and improve the efficiency of creating multiple email notifications for similar actions. If necessary, you can make minor changes on the fly to an
email that uses a template by overriding the subject line and message body content in the notification form. A common practice is to define the message body in a template and create new subject lines for different types of recipients. There is no limit to the number of templates that you can create.

Email templates are created in rich HTML format, and administrators have the option of converting existing email templates to rich HTML (starting with the Eureka release). This format provides several advantages, including:

- Raw HTML content is converted into a WYSIWYG format.
- The content can be edited in a feature-rich HTML editor.
- Mail scripts are condensed into a single, easy-to-read line that can be reused in multiple email notifications.
- To prevent broken links, images linked using URLs relative to a particular instance are converted to absolute links.

Create an email template
You can create an email template with rich HTML formatting, rather than plain text.

Role required: admin

1. Navigate to System Policy > Email > Templates.
2. Click New.
3. Fill in the form fields (see table).
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the template. For example, <code>change.update.risk</code>.</td>
</tr>
<tr>
<td>Application</td>
<td>The type of scoped application.</td>
</tr>
<tr>
<td>Email layout</td>
<td>If the message body for the template is to be formatted using a predefined email layout, select the layout.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the name of the table involved. For example, <code>Change Request [change_request]</code>.</td>
</tr>
</tbody>
</table>
| Subject             | Enter a subject line that explains the purpose of the email. Select the appropriate variables for the subject line from the fields available on the selected table. Place the cursor where you want the variable to appear, and click the field name in the Select variables column. For example:  
  ```
  ${sys_class_name} ${number} with ${risk} risk has been assigned to you.
  ```  |
| Message HTML        | Enter the content of the email template message. You can use the HTML editor toolbar to format the HTML, and you can include variables from the Select variables column. Variables map to column names available from the notification table, its parent tables, and reference tables. Use variables to include values from a record in the table such as an incident short description or comments and work notes.  
  Notes:  
  - When a template is applied to a notification, the contents of this field are used when you select HTML and plain text or HTML in the Content Type field in the Email Notification form.  
  - You cannot use HTML code to control the appearance of the contents in the `$(comments)` variable.  
  - If you want to include a link to the record that triggered the notification, see Enable links to records.  |
| Message Text        | Enter the notification message to send in plain text.  
  Note: When a template is applied to a notification, the contents of this field are used when you select HTML and plain text or Text in the Content Type field in the Email Notification form.  |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMS alternate</td>
<td>Create a different message to be delivered to an SMS device. Enter a brief message, showing the most important information only. If this message field is blank, the contents of the Message Text field are used for the SMS message.</td>
</tr>
</tbody>
</table>

**Note:** The message in this field is used when the message is sent to a device configured as SMS.

---

**Apply a template to an email notification**

After you create an email template, you can apply it to a notification.

Role required: admin

1. Navigate to **System Notification > Email > Notifications**.
2. Open the email notification record that should use the template.
3. Navigate to the **What it will contain** section.
4. From the **Email template** field, select the appropriate template.
5. Click **Update**.

**Convert an email template to rich HTML**

If you have an email template created prior to the Eureka release, you can convert it to rich HTML.

Role required: admin

1. Navigate to **System Policy > Email > Templates**.
2. Open the email template you want to convert.
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>notify.change</td>
<td>Incident [incident]</td>
</tr>
</tbody>
</table>

Email layout: Unsubscribe and Preferences

Subject: ${TABLE_NAME} ${DISPLAY_VALUE} Change Notification

Message:

Click here to view ${TABLE_NAME}: ${URI}
3. **Click Switch to Rich HTML Editor.**

When content is converted, these changes are made to the content:

- **HTML Editor:** Any raw HTML in the *Message* field is rendered as WYSIWYG text in the *Message HTML* field. The content can be edited in a feature-rich HTML editor.

- **Simplified Mail Scripts:** Any mail scripts in the body are automatically saved to the Email Script [sys_script_email] table and are replaced in the notification body with an embedded script tag.
This makes the template body easier to read and makes it easier to reuse scripts in multiple email templates.
**Email Template**

**notify.change**

- **Name**: notify.change
- **Table**: Incident [incident]

**Email layout**: Unsubscribe and Preferences

**Subject**: ${TABLE_NAME} ${DISPLAY_VALUE} Change Notification

**Message HTML**

Click here to view ${TABLE_NAME}: ${URL}
4. Modify the message text, as needed, using the WYSIWYG editor or by editing the underlying HTML.

**Note:** The letter "P" at the bottom of the screen shows the location of your cursor within the Message field. In this case, the cursor is in a line containing an `<HTML>` tag.

**Note:** Email templates that are already formatted with rich HTML do not show the Switch to Rich HTML Editor button.

Whether you are working with templates converted from earlier versions or creating new templates in the rich HTML format, it is a good practice to write mail scripts in System Notification > Email > Notification Email Scripts. When the scripts are completed, a `${mail_script:script name}` embedded script tag should be added to the email template body. This makes it easy to use the same scripts in multiple email templates. All that needs to be copied and pasted from one template to the next is the embedded script tag.

If you manually enter a mail script in the body of a new or converted email notification or template, and then attempt to save the record, a message asks whether the mail script should be converted. Unconverted mail scripts often fail to run from inside the HTML editor. If you select Yes, the script is added to the Email Script [sys_script_email] table and is automatically replaced in the body with an embedded script tag.

You can view the mail scripts in their original form by opening the email template and clicking the Show Notification Scripts related link.

**Construct an email message with a template**

Email templates provide a list of the fields from database tables that are available for constructing an email message.

An email template can include a mailto automatic response link, which enables the email recipient to simply choose a link that sends a preformatted response back to the instance. An example is the email template used for notification that an approval is required. The following example shows the base email:
<table>
<thead>
<tr>
<th>When to send</th>
<th>Who will receive</th>
<th>What it will contain</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Content type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HTML and plain text</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Importance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-- None --</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Include attachments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>From</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Omit watermark</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reply to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Push Message Only</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Push Messages</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Approval Request</td>
</tr>
<tr>
<td></td>
<td>Email template</td>
<td>change.itl.approve.role</td>
</tr>
<tr>
<td></td>
<td>Subject</td>
<td></td>
</tr>
<tr>
<td>Message HTML</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
In this case, when a change request approval is requested, an update is made to the `sysapproval_approval` table. The "approval events" business rule is then executed, which creates the "approval.inserted" event. The "Approval Request" email event is defined to process the approval.inserted event, and this email event is defined to use the following change.itil.approve.role email template. Notice that this template has two mailto: items specified. One for "mailto.approval" and one for "mailto.rejection."

This email template builds an automatic response that lets the email receiver simply click a link in the email to either approve or reject the change request.

Here is what the `change.itil.approve.role` template looks like using the rich HTML editor:
<table>
<thead>
<tr>
<th>Name</th>
<th>change.itl.approve.role</th>
<th>Application</th>
<th>Global</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email layout</td>
<td>Unsubscribe and Preferences</td>
<td>Table</td>
<td>Approval [sysapproval.approver]</td>
</tr>
<tr>
<td>Subject</td>
<td>${sysapproval.sys_class_name} ${sysapproval} Approval Request</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message HTML</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- \( \text{Short Description}: \text{${sysapproval.short_description}} \) 
- \( \text{Priority}: \text{${sysapproval.priority}} \) 
- \( \text{Category}: \text{${sysapproval.category}} \) 

- \( \text{Comments:} \text{${sysapproval.description}} \) 

- \( \text{Click here to view Approval Request:} \text{${URI}} \) 
- \( \text{Click here to view} \text{${sysapproval.sys_class_name}}: \text{${sysapproval.URI}} \) 

- div
The selection list on the right shows the available fields from the `sysapproval_approver` table.

Notice the `change.itil.approve.role` template also uses a predefined email layout (Unsubscribe and Preferences), which provides links for the recipient to unsubscribe from approval notifications and set notification preferences.

And here is the `mailto.approval` template:

```
Click here to approve ${sysapproval}
```

**Note:** If you put text on the lines following the **Click here to approve ${{sysapproval}}** line, this text forms the actual body of the email.

The combination of templates used would generate an email similar to the following example:
Short Description: Upgrade to a new version of Windows Office
Click here to view Approval Request: [LINK]
Click here to view Change Request: [LINK]

Priority: 4 – Low
Category: Software
Comments:
All matches for the sales department must be updated to the latest version of Windows Office

Click here to approve CHG30003
Click here to reject CHG30003

Unsubscribe | Notification Preferences

Template generated email message

Notice that the email recipient can use the following links in the mail:
• A link to view all the details of the change request
• A link to view the approval record
• A link that generates an automatic email response to approve the change
• A link that generates an automatic email response to reject the change
• A link to unsubscribe from approval notifications and another link to set notification preferences

Add blank lines in an email template
You can easily add blank lines in an email template using HTML tags.
Judicious use of these HTML tags can make your email easier to read.
• You can use `<br/>` to insert a line break
• You can wrap paragraphs in `<p> . . . </p>` tags to format your email nicely.

Calendar integration
With email notifications, you can use import export maps to leverage information about records and integrate with Outlook or another calendar.

For example, an email notification can create a calendar event based on the planned start and end dates of a change request. To enable integration with a calendar, the following iCalendar variables are available to be added to an email template message and reference the email template from the notification. The variables must be added to the Message Text field.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$(dtstart)</td>
<td>Start Date</td>
</tr>
<tr>
<td>$(dtend)</td>
<td>End Date</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>${location}</td>
<td>Location</td>
</tr>
<tr>
<td>${alarm_time}</td>
<td>Alert or reminder time</td>
</tr>
</tbody>
</table>

By default, the instance computes the value of iCalendar variables using import and export maps for the Appointment [itil_appointment] and Change Request [change_request] tables. The instance also uses import and export maps for other tables, depending on which plugins you activate. For example, if you activate the Incident (com.snc.incident) plugin, the instance uses the import and export maps of the Incident [incident] table.

Import export maps

Each import export map can specify a different set of iCalendar fields. For example, the icalendar.change_request import export map only maps two iCalendar fields.
iCalendar change request mappings

The instance uses the **External Name** value as the variable name in the email template. For example, the icalendar.change_request import export map defines the *dtstart* and *dtend* variables.

<table>
<thead>
<tr>
<th>External name</th>
<th>Associated variable name</th>
<th>Table</th>
<th>Field mapped</th>
<th>Field label</th>
</tr>
</thead>
<tbody>
<tr>
<td>dtstart</td>
<td>${dtstart}</td>
<td>change_request</td>
<td>start_date</td>
<td>Planned start date</td>
</tr>
<tr>
<td>dtend</td>
<td>${dtend}</td>
<td>change_request</td>
<td>end_date</td>
<td>Planned end date</td>
</tr>
</tbody>
</table>

Map date fields to iCalendar variables

You can specify what fields provide the date information in calendar invitation notifications by changing the field mappings of the *dtstart* and *dtend* variables in the import export map for the iCalendar invitation.

Role required: admin

1. In the navigation filter, enter `sys_impex_map.list`. 
2. Open a map to edit.

![Import Export Maps](image)

<table>
<thead>
<tr>
<th>All &gt; Type = icalendar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Table</td>
</tr>
<tr>
<td>icalendar,change_request</td>
</tr>
<tr>
<td>icalendar,u_my_custom_table</td>
</tr>
<tr>
<td>icalendar,til_appointment</td>
</tr>
<tr>
<td>Appointment [til_appointment]</td>
</tr>
</tbody>
</table>

3. In the Field Maps related list, click either the **end_date** or **start_date** mapped field to change the mapping for **dtstart** or **dtend**, as needed.
4. Change the **Database** field to the field you want to use to set the start date or end date.
5. Click **Update**.

Create iCalendar invitations for custom tables

To generate iCalendar invitations that use field values from custom tables, create an import export map that computes the values of the iCalendar fields.

Role required: admin

1. Create the custom table and fields using the **Date/Time** field type for the fields that map to the **${dtstart}** and **${dtend}** variables.
2. In the navigation filter, enter **sys_impex_map.list**.
3. Click **New**.
4. Set the following fields:
   - **Name**: Use the following naming convention: **icalendar.<table name>**. For example, **icalendar.u_my_custom_table**.
   - **Table**: Select the custom table you created.
   - **Type**: Select **icalendar**.
5. Right-click the form header and select **Save**.
6. In the Field Maps related list, click **New**.
7. In the Mapping Entry Wizard, select **Mapping to a Database Field**.
8. Create field mappings for **dtstart** and **dtend**. These variables are required.
   - For example, map the **External Name dtstart** to the **u_meeting_start_time** field in **u_my_custom_table**.
9. Click **Submit**.
10. Create field mappings for any other iCalendar fields as necessary.
11. Click **Update**.

Here are sample field mappings between iCalendar variables and custom fields in a custom table, `u_my_custom_table`:

**Sample field mappings**

<table>
<thead>
<tr>
<th>External name</th>
<th>Database field</th>
<th>Type</th>
<th>Map</th>
</tr>
</thead>
<tbody>
<tr>
<td>dtstart</td>
<td>u_meeting_start_time</td>
<td>field</td>
<td>icalendar.u_my_custom_table</td>
</tr>
<tr>
<td>dtend</td>
<td>u_meeting_end_time</td>
<td>field</td>
<td>icalendar.u_my_custom_table</td>
</tr>
<tr>
<td>description</td>
<td>u_meeting_description</td>
<td>field</td>
<td>icalendar.u_my_custom_table</td>
</tr>
</tbody>
</table>

12. Create an email template that defines what to include in the iCalendar invitation.

   a) Set the **Table** field to the custom table you created.
   
   b) In the **Message** text field, use the following format to define the iCalendar invitation.

   ```
   BEGIN:VCALENDAR
   PRODID:--//Service-now.com//Outlook 11.0 MIMEDIR//EN
   VERSION:2.0
   METHOD:REQUEST
   BEGIN:VEVENT
   ATTENDEE;ROLE=REQ-PARTICIPANT;RSVP=TRUE:MAILTO:${to}
   DTSTART:${dtstart}
   DTEND:${dtend}
   UID:${sys_id}
   DTSTAMP:${dtstamp}
   DESCRIPTION:${description}
   SUMMARY:${u_meeting_summary}
   END:VEVENT
   END:VCALENDAR
   ```

   **Note:** Mail script is not allowed or processed in meeting invitation email templates.

**iCalendar invitation template details**

<table>
<thead>
<tr>
<th>iCalendar template line</th>
<th>Required?</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEGIN:VCALENDAR</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>PRODID:--//Service-now.com//Outlook 11.0 MIMEDIR//EN</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>VERSION:2.0</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>METHOD:REQUEST</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>BEGIN:VEVENT</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>ATTENDEE;ROLE=REQ-PARTICIPANT;RSVP=TRUE:MAILTO:${to}</td>
<td>Yes</td>
<td>You must use the import export map to map dtstart to a start time field on the custom table.</td>
</tr>
<tr>
<td>DTSTART:${dtstart}</td>
<td>Yes</td>
<td>You must use the import export map to map dtstart to a start time field on the custom table.</td>
</tr>
<tr>
<td>DTEND:${dtend}</td>
<td>Yes</td>
<td>You must use the import export map to map dtend to an end time field on the custom table.</td>
</tr>
<tr>
<td>iCalendar template line</td>
<td>Required?</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>UID:{$sys_id}</td>
<td>Yes</td>
<td>You must provide the name of a field that uniquely identifies the record, such as the sys_id or the record number field.</td>
</tr>
<tr>
<td>DTSTAMP:{$dtstamp}</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DESCRIPTION:{$description}</td>
<td>No</td>
<td>To include a multiple line description, you must use the import export map to map description to a text field on the custom table. The field mapping ensures that the system encodes line breaks correctly for the iCalendar file format.</td>
</tr>
<tr>
<td>SUMMARY: ${u_meeting_summary}</td>
<td>No</td>
<td>To include a summary from a text field on the custom table, provide the name of the field, such as u_meeting_summary. The summary field value must not contain line breaks. You do not need to create a field mapping.</td>
</tr>
<tr>
<td>END:VEVENT</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>END:VCALENDAR</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

13. Create an email notification to trigger the iCalendar invitation and ensure the following fields are set accordingly:
   - **Table**: Select the custom table.
   - **Type**: Select **Meeting Invitation**.
   - **Content type**: Select **Plain text** only.
   - **Email template**: Select the template you created.

**Email layouts**

Create reusable content for the message body of email templates.
Administrators can use email layouts to:

- Ensure all email notifications have a consistent layout such as always displaying a header, body, and footer.
- Display static content on all email notifications such as a company logo or a background.
- Declare inline styles available for use in the message body of an email template such as setting a text font, size, and color.
- Provide users with links to common response actions such as unsubscribe from a notification or manage notification preferences.

**Note:** To display dynamic content such as mail scripts, use email templates. For more information, see Create an email template.

Email layouts insert HTML elements into the message body of email templates. Any style elements you define in the email layout are available to the email template. Email layouts support style sheets in these formats.

- Internal style sheets defined within a `<style>` element.
- Inline styles within a `style` attribute.

By default, the system includes several sample layouts administrators can use to create their own layouts. Administrators can create email layouts using an inline HTML editor or manually entering HTML code. The system stores email layout records in the Email Layout [sys_email_layout] table.

**Create an email layout**

Create an email layout to specify the HTML content you want to appear in the body of one or more email templates.

- Role required: admin
- Record required: email template record

1. Navigate to System Policy > Email > Layouts.
   The system displays the list of existing email layouts.
2. Click New.
   The system displays a blank email layout form.
3. Fill in the form.

**Email layout fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specify a unique name for the record.</td>
</tr>
<tr>
<td>Application</td>
<td>Lists the parent application to which this record belongs.</td>
</tr>
<tr>
<td>Description</td>
<td>Specify an optional description of the layout.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select whether to display the Advanced Layout field.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>Use the inline editor to add HTML elements. The system displays HTML from this field in the body of any email template that uses the layout. Include notification variables to show content from the related record. For more information notification variables see <a href="#">Notification variables</a>.</td>
</tr>
<tr>
<td>Advanced Layout</td>
<td>Use this field to manually enter HTML code. The system displays HTML from this field in the body of any email template that uses the layout.</td>
</tr>
</tbody>
</table>

**Note:** The editor automatically formats any HTML code you enter from the [Source code](#) view.

**Note:** To enter text in this field, select [Click here to disable syntax highlighting and script formatting](#).

4. Click **Submit**. The system creates the email layout record.
5. Navigate to **System Policy > Email > Templates**. The system displays the list of existing email templates.
6. Select the email template which you want to use an email layout. The system displays the email template record.
7. In **Email layout**, select the email layout you want to use to format the body of email messages.
8. Click **Update**. The email template uses the selected email layout to format the body of email messages.

### Email filters

Email filters enable administrators to specify when to move email to particular mailboxes or to ignore it using a condition builder or a condition script. The Email Filters (com.glide.email_filter) plugin is active by default.

When an email is *ignored*, the email is saved to your instance but is not processed. You can access an ignored email by viewing its Email [sys_email] record.

### Default email filters

By default, the following filters are available from the **System Mailboxes > Filters** module:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore VCAL</td>
<td>Ignores all email containing vCalendar requests. This filter prevents inbound email actions from creating unnecessary incident records when the instance receives a response to sent email. vCalendar requests in email responses are identified by the EmailUtils script include.</td>
</tr>
<tr>
<td>Filter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ignore header</td>
<td>Ignores email that contains specific headers. This filter overrides the glide.pop3.ignore_headers property.</td>
</tr>
<tr>
<td>Ignore sender</td>
<td>Ignores email from specific senders. This filter overrides the glide.pop3.ignore_senders property.</td>
</tr>
<tr>
<td>Ignore subject</td>
<td>Ignores email with specific terms or phrases in the subject line. This filter overrides the glide.pop3.ignore_subjects property. This filter might not apply to emails arriving from unknown users. Unknown users can be locked out.</td>
</tr>
<tr>
<td>Move spam to junk folder</td>
<td>Moves email identified as spam to the Junk folder. This filter checks for the value of the ServiceNow spam header. If the header is X-ServiceNow-Spam-Status:Yes, the filter moves the email to the Junk folder</td>
</tr>
</tbody>
</table>

**Note:** To learn more about enabling spam scoring and filtering, see #unique_1909 in Instance Security Hardening Settings.

### Email filter script include

Email filters use a script include called `EmailUtils` that contains a simple utility function to determine if `vCalendar` is in the body of the response email. The results of this query are used in a condition script in the `Ignore VCAL` email filter.

### Spam scoring and virus scanning

Every message sent through email servers is assessed for the likelihood of being spam. Based on this assessment, the instance adds headers to each message that can be used for filtering within the customer instance using the Email Filters plugin.

The system also adds the `X-ServiceNow-Virus:INFECTED` header to an email that contains one or more virus-infected attachments. The system ignores the email.

Spam scoring and virus scanning are available only for instances that use the ServiceNow email infrastructure. For more information on spam scoring and filtering, see KB0549426.

**Activate email filters**  
Administrators can activate the Email Filters plugin (com.glide.email_filter).

Role required: admin

1. Navigate to **System Applications > All Available Applications > All.**  
2. Find the plugin using the filter criteria and search bar.  
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.  
3. Click **Install,** and then in the Activate Plugin dialog box, click **Activate.**

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following...
Create an email filter

You can create email filters to apply a custom action script or filter actions when email matches your filter's conditions.

Role required: admin

1. Navigate to **System Mailboxes > Administration > Filters**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the email filter.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the email filter.</td>
</tr>
<tr>
<td>Order</td>
<td>Priority that the email filter takes over other filters for the same table. To give the filter higher priority over other filters, enter a lower number.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the email filter.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description of what the filter does.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions to define which emails to filter. Note that conditions are case sensitive.</td>
</tr>
<tr>
<td>Condition script</td>
<td>Script to define which emails to filter. Use this script to access other tables, variables, or methods. For example, the condition script for the Ignore VCAL filter looks for the results of the EmailUtils script include, which detects vCalendar attachments.</td>
</tr>
<tr>
<td>Action script</td>
<td>Script to define additional behavior to be performed when the filter condition evaluates to true. This might include an email action not included in the default filter actions. In the base system, the action script is used to produce the error string that is published to the email log (<strong>System Logs &gt; Email</strong>).</td>
</tr>
</tbody>
</table>

4. Right-click in the header bar and select **Save** from the context menu.

The **Filter Actions** related list appears.

5. Click **New** in the related list.

6. Select how the system should react when the conditions of this filter evaluate to true.

The two choices in the base system are: **Mark as Ignored** and **Move to Junk**. You can use the **Action script** to perform additional email tasks.

**Note:** Before creating additional email actions with a script, see **Inbound Email Actions**. Like business rules, inbound email actions use both conditions and scripts and can provide a number of useful actions on emails the instance receives.

Email retention

You can archive and eventually destroy email messages that you no longer need or if your Email table is excessively large.

Email retention is available starting with the Helsinki release.
Email archive and destruction plugins

The email archiving and destruction feature uses the Data Archiving and Email Retention plugins. The Data Archiving plugin must be active to archive and destroy email records. The Email Retention plugin provides a set of rules that specify when the system archives and destroys email records.

Note: The Email Retention plugin also prevents the system from deleting watermarks, which are required for inbound email actions to continue to function.

The Email Retention plugin and associated archive and destroy rules are active by default on new instances. On upgraded instances, you must manually activate both the plugin and the archive and destroy rules. ServiceNow recommends that you review and approve these rules before activating them.

If your instance already has a process to manage email records, you do not need to activate the Email Retention plugin. If you want to replace your current process with Email Retention, be sure to deactivate the current process before activating the archive and destroy rules.

Archiving and destroying email records

Archiving means moving records from the Email [sys_email] table to the Archive Email [ar_sys_email] table when they exceed the archive rule time limit. Destroying means deleting records in the Archive Email table when they exceed the destroy rule time limit.

Note: When a destroy rule deletes email records, associated watermarks are not deleted. They are preserved to ensure that your inbound email actions continue to function.

Default archive and destroy rules

Email Retention provides these email archive rules:

- **Emails - Ignored and over 90 days old**: archives email message records that were created more than 90 days prior to the current date and are of type received-ignored or sent-ignored.
- **Emails - Over a year old**: archives email message records that were created more than 365 days prior to the current date.

Email Retention also provides this email destroy rule:

- **Email Archive - Over a year old**: destroys email records that have been archived for more than 365 days prior to the current date.

With these default settings, your email messages are kept on the instance for a total of two years: one year in the Email table, and one year in the Email archive table. At the end of this period, the system deletes the expired email records from the Email archive table.

Note: By default these rules are active on new instances and inactive on upgrades. The system runs archive and destroy rules when you activate them.
Compatibility with other record management implementations

If you are already using another method to manage email records, such as table cleaners, you do not have to use the Email Retention feature. To prevent unexpected record deletion, ServiceNow recommends that you avoid using multiple email management processes on the same instance at the same time.

Note: For assistance replacing your existing record management implementation with Email Retention, contact your professional services or sales representative.

Effects of archiving and deleting email records

Inbound email actions copy the body of an email to the work notes of the related record. If the inbound email record is later deleted, the work notes still contain a text copy of the email.

When the system sends an email message about a record, the activity formatter displays a Sent Email section with a link to the email message. If the system archives the email message, the activity formatter removes Sent Email section. When the system deletes the email message, it is no longer visible in the activity formatter nor the work notes.

Note: Set the archive time length long enough so your users can access sent emails though the activity formatter.

Archiving email records changes the methods available to the system to identify inbound email as a reply. After archiving an email record, the system can no longer use the In-Reply-To field to match an incoming email to an email record. However, the system can still match incoming email to an existing record from a record number or watermark.

Activate the Email Retention plugin

The Email Retention plugin provides archive and destruction rules for email messages. It is active by default for new instances, but must be activated for upgrades.

Required role: admin

The Email Retention plugin requires these plugins:

- Data Archiving
- System Mailboxes

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Archive email manually

You can archive email messages manually on demand instead of waiting for the instance to archive them based on a scheduled job.

Role required: admin
Email Retention provides these email archive rules:

- **Emails - Ignored and over 90 days old**: archives email message records that were created more than 90 days prior to the current date and are of type `received-ignored` or `sent-ignored`.
- **Emails - Over a year old**: archives email message records that were created more than 365 days prior to the current date.

You can manually archive email messages that meet these archive rules or any additional archive rules that you create.

**Note**: An archive record must be active for the instance to be able to process records with it.

1. Navigate to **System Archiving > Archive Rules**.
2. Open the email archiving rule that you want to modify.
3. Click **Recalculate Estimate** to see how many records in the `Email [sys_email]` table are going to be archived. The estimate appears in the **Record estimate** field.
4. Click **Run Archive Now**.

**Note**: You can also archive related records.

---

**Watermarks on notification emails**

By default, the system generates a watermark label at the bottom of each notification email to allow matching incoming email to existing records. Each watermark includes a random 20-character string that makes it unique.

Starting with the Jakarta release, the system automatically generates randomized watermarks for notification emails in base systems. The random 20-character string reduces the possibility of a watermark being guessed or coincidentally matching the watermark of an email from another instance.

**Note**: If you are upgrading from a release before Jakarta, random watermark support is optional and requires the Random Watermark Support plugin to be activated.

**Watermark format**

The email watermark always begins with **"Ref:"** to identify the label as a watermark. After this identifier, the default label is 31 characters in length and consists of:

- Customizable prefix — The default prefix is **MSG**.
- Auto-numbered identifier — The numeric string identifying the source record, such as incident, problem, or change request.
- An underscore character followed by a random 20-character string
Randomized watermark example

When inbound emails are processed, the system matches random watermarks to the appropriate source records.

Watermark configuration

Watermarks are always generated, but you can configure them to:

- Create a custom watermark prefix for each instance to prevent accidentally triggering events in the wrong instance.
- Have custom prefix characters after MSG
- Be hidden globally
- Be omitted from individual email messages

If watermarks are omitted from email notifications, inbound email actions might not work properly. Without a watermark, the system processes inbound email messages as described in Criteria for matching email to inbound actions.

i Note: Email clients that use the plain text version of the email still show the watermark.

Create a custom watermark prefix for email notifications

By default, email notifications use the watermark prefix MSG, but you can create a custom watermark prefix.

Role required: admin

Any email notifications that are forwarded from one instance to another might be more easily distinguished with different prefixes for each instance. To avoid unintentionally triggering events in the wrong instance, create a unique watermark prefix for each instance.
1. Navigate to **System Definition > Number Maintenance**.
2. Open the **MSG** record in the Email Watermark [sys_watermark] table.
3. Enter the unique **Prefix** for this instance.

   ![Table](image)

   - **Table**: Email Watermark
   - **Prefix**: MSGTEST
   - **Number**: 0
   - **Application**: Global
   - **Number of digits**: 7

4. Click **Update**.

Your custom watermark applies to all new email notifications. Email notifications that existed before you created a custom watermark keep the same watermarks as before.

**Omit an email notification watermark**

You can omit watermarks on email notifications if you do not want the instance to match the notification to an existing record.

Role required: admin

1. Navigate to **System Notification > Email > Notifications**.
2. Select the email notification to update.
3. Click the Advanced View related link.
4. In the **What it will contain** section, select the Omit watermark check box.

When incoming email does not contain a watermark, the system searches the subject line and message body for a record number. The system attempts to match any record number that it finds to an existing record. If there is a matching record number, the system updates the record with the values in the incoming email. To ensure that response email messages don't update records, remove the record number variable `${number}` from the **Subject** and **Message HTML** fields.

**Hide email watermarks globally**

Rather than omitting watermarks, it is possible to hide watermarks on a global basis using HTML markup.
Role required: admin

Watermarks can only be hidden in the HTML message. The text version of the message, because it does not have markup allowing show/hide semantics, will always have the watermark.

1. Navigate to sys_properties.list in the Application Navigator.
2. Create a new property named glide.email.watermark.visible and set it to false.

This ensures that all watermarks are hidden on all email messages. This cannot be done on a per-email basis.

System mailboxes

Email messages can be seen in the System Mailboxes menu, which gives you access to the system Inbox, Outbox, and Sent mailbox.

Each provides a filtered view of emails to let you see only what you need to at any given time, including list fields applicable to each. The system mailboxes menu shows your current POP and SMTP status.

The System Mailbox is hosted by ServiceNow, who have sole access to the mailboxes. By default, once the instance pulls an email message, it is deleted from the mail server and stored in the application on the Email [sys_email] table.

For information about the fields that are shown in the System Mailbox, see System email log and mailboxes. You can configure the layout of a system mailbox to show any of the email log fields, not only the ones that are shown by default.

- **Inbound emails**: All inbound mail is placed into the Inbox until it is processed. After it is cleared, the email moves to the Received state. If the email message matches the criteria in an inbound email action, the email is changed to Processed. If not, it is changed to Ready. If the system is restarted for any reason (such as during a system upgrade), all inbound mail waits on the external mail server until the system can request delivery.

- **Outbound emails**: All outbound mail is placed into the Outbox until it is processed. Once cleared, it is moved to Sent (if sent) or Skipped (not sent, as in the case of no valid recipients). If the system is restarted for any reason (such as during a system upgrade), all outbound mail waits in the instance database until the system comes online, and the scheduler looks for mail to deliver.

The email client

The email client enables you to send email directly from any record, such as an incident, change request, problem, or user record.

The email client is available by default, and enabled by default on the incident table.

The email client can be useful in cases where you want to send an email:

- To engage more people in a piece of work
- That includes Cc and Bcc recipients
- That includes personalized comments
- To a third party who doesn't have an account in your instance
- To someone about an incident where you don't have an email notification set up to do exactly what you want

The email client always uses the multipart/mixed content type and supports HTML markup in the message body.

**Note**: Line breaks do not appear for multi-line fields such as ${description} and ${comments} in the email client template.
Enable the email client for a table
Enable the email client for a table so that users can send emails directly from the table record.

Role required: admin

The email client is enabled by default on the Incident [incident] table. You can enable the email client for another table by adding the `email_client` dictionary attribute to the table.

Note: This capability is not inherited by tables that extend the current table. For example, enabling the email client on the Task table does not enable it for the Incident or Problem tables.

1. Open a record in the table that you want to enable the email client for.
   For example, to enable the email client for the Problem [problem] table, navigate to Problem > Open, and then open any problem record.
2. On the form, click the menu icon
   and then click Configure > Dictionary.
3. On the Dictionary Entries list, open the first record.
   The first record has the record type Collection and does not have any entry for Column name.
4. On the form, in the Related Links section, click Advanced view.
5. In the Attributes field, enter `email_client=true`.
   If there are other values in the field, separate the attribute with a comma.
6. Click Update.

Components installed with the email client
Several types of components are installed with activation of the Email Client (com.glide.email_client) and Email Client Template (com.glide.email_client_template) plugins, including tables and user roles.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email client administrator [email_client_admin]</td>
<td>Configures the email client to fit the needs of your organization.</td>
<td>• email_client_quick_message_author</td>
</tr>
<tr>
<td>Read-only role for email client templates [email_client_template_read]</td>
<td>Reads email client templates and requests the email client administrator to reconfigure the templates as needed.</td>
<td>• None</td>
</tr>
<tr>
<td>Quick message author [email_client_quick_message_author]</td>
<td>Creates quick messages for users in their group.</td>
<td>• None</td>
</tr>
</tbody>
</table>
### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Client Configuration</td>
<td>Controls for the email client. There is only one Email Client Configuration record for each table that uses the email client.</td>
</tr>
<tr>
<td>[sys_email_client_configuration]</td>
<td></td>
</tr>
<tr>
<td>Email Client From Address</td>
<td>Email addresses that users can select as the From address of an email client message.</td>
</tr>
<tr>
<td>[sys_email_client_from_address]</td>
<td></td>
</tr>
<tr>
<td>Recipient Qualifier</td>
<td>Email addresses that users can send email client messages to.</td>
</tr>
<tr>
<td>[sys_recipient_qualifier]</td>
<td></td>
</tr>
<tr>
<td>Email Client Template</td>
<td>Templates that are applied automatically to qualified email client messages.</td>
</tr>
<tr>
<td>[sys_email_client_template]</td>
<td></td>
</tr>
</tbody>
</table>

**Email client interface**

The instance’s email client interface looks like a standard email interface, which contains a toolbar for text formatting and adding attachments.

Users see an email icon based on the UI version.

- UI16: The email icon (✉️) appears in the more options menu.
- UI15: The email icon (✉️) appears in the form header.

Users click the email icon to launch the email client as a pop-up window.
Compose Email

Reply to

To

guest@example.com; Add Recipient

Cc

Add Recipient

Bcc

Add Recipient

Subject

INC0010002 - SAP Sales app is not accessible

Attachments

This is an email message using the TinyMCE editor.
**Email client configurations**

Use email client configurations to manage the behavior of your email client. Each configuration consists of different email controls for setting allowable email recipients and email addresses.

In new and upgraded instances, the Email Client Configuration module is activated by default through the Email Client (com.glide.email_client) and Email Address Filter (com.glide.email_address_filter) plugins.

**Note:** If you upgraded to the Madrid release, a default email client configuration is created automatically during upgrade. This default email configuration is used if you do not define any other email client configurations. Also, if you previously defined certain email client properties to control email address auto-complete, disambiguation, and the display of the From and Reply-To email addresses, those settings are retained in the default email client configuration.

**How email client configurations work**

Email client configurations determine how your email client behaves, such as whether the From address or Reply-To address should be displayed, and the allowable addresses that can be entered by your users. A configuration applies to a specific ServiceNow table, which enables you to define email client behavior for a specific context, purpose, or application. For example, if you have email client users who send email about Customer Service case records, you can create a configuration that applies email client controls specific to customer service. You can select the email client recipient qualifiers for controlling the auto-complete recipient results from a selected table, such as the Customer Contact table. You can also set email address filters that determine the allowable addresses from a table, such as the Customer Contact table.

An email client configuration consists of the following components:

**Email client recipient qualifiers**

Recipient qualifiers control the email recipients returned in the auto-complete results for the To, Cc, and Bcc fields of the email client. You can provide additional qualifiers displayed in the auto-complete results to differentiate recipients that have the same names and narrow the results.

**Email client From addresses**

This control enables the display of the From and Reply-To addresses. Use the Email Client Template to create a set of allowable From addresses that can be used when a user sends an email with the email client. You can provide a specific From address to be used in the email client, or you can choose to hide it entirely.

**Email client attachment handling**

By default, attachments that are sent from the email client are attached to the target record. Instead, you can select to attach files to the Email [sys_email] record, or you can set conditions that define which email client attachments are added to the target record. To see the status of all email attachments, go to the Email Attachments [sys_email_attachment] table.

**Email address filters**

Email address filters allow or disallow certain email addresses that users can enter in the email client. You can specify an email whitelist that specifies allowable domains or an email blacklist that disallows certain domains.

You can also use an Email Client Template to define the content of an email client message and set other message characteristics, such as an email sender (From address) configuration.
Email client configuration process

Users with the admin role define and edit email client configurations. Users with the email_client_admin role can edit configuration information in selected tables.

1. Build the various email client controls that can be used to create an email client configuration.
   - Define email client recipient qualifiers.
   - Set email address filters that allow or disallow email addresses that can be entered in the email client.

2. Create the email client configuration.

Define an email client configuration that determines how your email client behaves when users create an email message.

Define email client recipient qualifiers

Create a configuration that controls the auto-complete list of recipients displayed in the email client. You can specify recipient qualifiers that display additional fields (from a selected ServiceNow table) in the auto-complete list. These fields differentiate email recipients who have the same first and last names.

Role required: email_client_admin or admin

Use the following tabs in the Email Client Recipient Qualifier form to define a recipient configuration.

- **Display Configuration** – Set up the email recipient auto-complete behavior and optionally select additional fields to differentiate recipients who have the same name. The additional fields ensure that users select the proper recipient for an email.
- **Query Configuration** – Specify a condition or script that queries the selected table and filters the recipient results returned.

You can define different recipient configurations, which can be used in an email client configuration.

1. Navigate to Email Client > Email Client Recipient Qualifier and click New.
2. Fill in the fields at the top of the Recipient Qualifier form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for this email client recipient configuration.</td>
</tr>
<tr>
<td>Application</td>
<td>The type of scoped application.</td>
</tr>
<tr>
<td>Table</td>
<td>The ServiceNow table to be queried for recipients.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of this recipient configuration.</td>
</tr>
</tbody>
</table>

3. Fill in the fields in the **Display Configuration** tab to control the autocomplete display in the email client.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Address field</td>
<td>The field on the table that contains the recipient email address.</td>
</tr>
<tr>
<td>Display Name Field</td>
<td>The field on the table used for the recipient name displayed.</td>
</tr>
<tr>
<td>Order</td>
<td>The order of results returned relative to other recipient qualifiers defined.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Additional Display Fields</td>
<td>A content list for choosing additional fields from the table to be displayed in the auto-complete list. Differentiates recipients who share the same name.</td>
</tr>
<tr>
<td>Search Additional Fields</td>
<td>A checkbox for enabling additional fields to be searched. Expands the recipients returned in the auto-complete list by querying (searching) the Additional Display Fields.</td>
</tr>
</tbody>
</table>

4. Fill in the fields in the Query Configuration tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Type  | Select the method for filtering the recipients returned in the auto-complete list:  
  • Condition  
  • Script  |
| Conditions | If you selected Condition for the Type, use the condition builder to specify the conditions that must be met to return the appropriate recipients. |
| Script | If you selected Script for the Type, enter a script that uses these variables to return the appropriate recipients:  
  • recipientQuery: GlideRecord for the table being queried.  
  • targetRecord: GlideRecord for the target record from which the email client was opened.  

For example, this recipientQuery is a GlideRecord that represents the Customer Contact table. The targetRecord variable is a Customer Service case from which the email client was opened. This query limits the email client autocomplete results to contacts who belong to the same account as the Customer Service case.

```javascript
(function (recipientQuery, targetRecord) {
    // Limit results to contacts belonging to the account for the case.
    var account = targetRecord.getValue('account');
    recipientQuery.addQuery('account', account);
})(recipientQuery, targetRecord);
```
5. Click **Submit**.
   The recipient qualifier configuration is added to the Recipient Qualifier [sys_recipient_qualifier] table and is available for use in an email client configuration.

**Define email client from addresses**
Set an allowable email address that is displayed in the From address of a message sent from the email client.

Role required: admin

1. Navigate to **Email Client > Email Client From Address** and click **New**.
2. In the **Display name**, enter the name to be displayed in the From field of the email client message.
3. Enter a valid **Email address** for the From address in the email client.
4. Click **Submit**.
   The From address is added to the Email Client From Address [sys_email_client_from_address] table.

**Set email address filters**
Define email filters that restrict the email recipients that users can enter in the email client. You can filter by domain or by specifying certain addresses.

Role required: email_client_admin or admin

You can specify two types of email address filters:

- **Whitelist**: A list of allowed domains for email recipients who can be selected in the email client.
- **Blacklist**: A list of disallowed domains for email recipients who cannot be selected in the email client.

You can also specify email address exceptions to the allowed or disallowed domain.

1. Navigate to **Email Client > Email Address Filters**, and then click **New**.
2. Enter the **Name** of the address filter.
3. Select the filter **Type**:
   - **Whitelist**: Allow all specified domains. All other domains are disallowed.
   - **Blacklist**: Disallow all specified domains. All domains that do not match the blacklisted domains are allowed.
4. In the **Domains** field:
   a) Click the lock icon to unlock it and access the domains controlled by this filter.
   b) Select an existing domain or enter a new domain:
      - If the filter **Type** is Whitelist, click the Search icon. Select the domains for which all email addresses are allowed. To add a new domain, click **New**, enter the **Domain**, and click **Submit**.
      - If the filter **Type** is Blacklist, click the Search icon. Select the domains for which all email addresses are disallowed. To add a new domain, click **New**, enter the **Domain**, and click **Submit**.
   c) Click the lock icon to lock the **Domains** field.

---

**Note:** You can specify a wildcard (*) in the domain name, for example *.com. If you create an email configuration that has multiple email address filters, all the filters evaluate the given email addresses. The filters determine whether the addresses are valid and the message can be sent as outbound email.
5. Specify any email addresses that are *Exceptions* to the domains specified in step 4.
   a) Click the lock icon to open the Email Address Filter Exceptions [sys_email_address_filt_except] table.
   b) Click the search icon to choose an existing email address. To add a new email address, click **New**, enter the email address exception, and click **Submit**.
      
      **Note:** You can specify a wildcard (*) in an email address exception.
   c) Click the lock icon to lock the **Exceptions** field.
      The exception is added to the Email Address Filter Exceptions [sys_email_address_filt_except] table.

6. Click **Submit**.
   The email address filter is added to the Email Address Filters [sys_email_address_filter] table.

   **Email address filter — whitelist exception example**
Email address filter — blacklist exception example

Create an email client configuration

Define a configuration that controls the display and behavior of the email client that is based on a selected ServiceNow table. The configuration determines the recipient auto-complete results that are displayed, email addresses that can be entered, and a set of allowable From addresses to be used when sending a message with the client.

Role required: email_client_admin or admin

You can create one email client configuration per ServiceNow table.

1. Navigate to Email Client > Email Client Configuration and click New.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for this email client configuration.</td>
</tr>
<tr>
<td>Application</td>
<td>Type of scoped application.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates that the configuration is active. The configuration is</td>
</tr>
<tr>
<td></td>
<td>active by default.</td>
</tr>
<tr>
<td>Table</td>
<td>ServiceNow table that this client configuration applies to. Select a table</td>
</tr>
<tr>
<td></td>
<td>from the list.</td>
</tr>
</tbody>
</table>

3. In the Recipient Configuration section, select Recipient Qualifiers to be used for this client configuration.
   a) Click the lock icon
      ![Lock icon]
      By default, two types of recipients are available: Active Users with email accounts and Active Groups with email accounts.
   b) Click the search icon
      ![Search icon]
      and select a recipient configuration from the list of available recipient configurations.
c) Click the lock icon

    to lock it.

4. In the Display Configuration section:
a) Select the **Display From** option to display the From email address in the email client. To hide the From email address in the email client, clear the check box.
b) Select the **Display Reply-To** option to display the Reply To address in the email client. To hide the Reply To email address in the email client, clear the check box.

5. In the Attachment Handling section, select from one of three choices for the **Attachment Send Action** field:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach to Email Record</td>
<td>Keep email client attachments on the Email [sys_email] record when you send an email.</td>
</tr>
<tr>
<td>Attach to Target Record</td>
<td>Attach email client attachments to the target record when you send an email. This option is the default value.</td>
</tr>
<tr>
<td>Conditionally Attach to Target Record</td>
<td>Set conditions that define which email client attachments are moved to the target record when you send an email. Attachments that do not meet the conditions remain on the email record when you send an email.</td>
</tr>
</tbody>
</table>

6. In the Filter Configuration section, select **Email Address Filters** to be applied to the email client.
   a) Unlock the lock icon

   b) Click the search icon

   and select one or more Email Address Filters.

   c) Click the lock icon

   to lock **Email Address Filters**.

Each filter that you select evaluates a given email address and determines whether or not the given address is valid to apply to an outbound email.

7. Click **Submit**.

   The configuration is added to the Email Client Configuration [sys_email_client_configuration] table.

   **Customize the email client**

   The email client has default properties and values that you can customize to suit your needs.
Email client default properties and values

<table>
<thead>
<tr>
<th>Property</th>
<th>Default Value</th>
<th>How to Customize</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACL access</td>
<td>Defaults to allowing only users with the itil role to access the email client.</td>
<td>To control who can see the email client, see Control access to the email client.</td>
</tr>
<tr>
<td>Email icon</td>
<td>Allows only users with write access to the current table to see the email icon.</td>
<td>To remove the email icon, see Email icon display.</td>
</tr>
<tr>
<td>To</td>
<td>Defaults to the email address of the caller.</td>
<td>To edit the default value, create an email client template.</td>
</tr>
<tr>
<td>Cc</td>
<td>Defaults to the email addresses of the user who opened the incident and all users in the watch_list.</td>
<td>To edit the default value, create an email client template.</td>
</tr>
<tr>
<td>Subject</td>
<td>Defaults to the incident number and short description.</td>
<td>To edit the default value, create an email client template.</td>
</tr>
</tbody>
</table>

Control access to the email client
You can control access to the email client by changing an ACL rule.

Only users with the itil role can access the email client. The following ACL rule controls this access:

ACL rule

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>EmailClientProcessor</td>
<td>processor</td>
<td>execute</td>
</tr>
</tbody>
</table>

Note: Because the visibility of the email icon is determined by whether the current user has write access to the table, it is possible that a user may be able to see the email icon and still not open the email client.

Create an email client template
You can create a different template for each table that uses the email client.

Role required: admin

The email client uses its own email templates to define default values for fields. Use the following sections in the Email Client Template form to build a client template:

- **Content**: The message body.
- **Recipients**: The email addresses of users receiving the email message. The email addresses are displayed in the To, Cc, and Bcc fields of the message.
- **Sender Configuration**: The method used to generate the email sender (From email address) of the message.

1. Navigate to Email Client > Email Client Templates.
2. Click New.
3. Fill in the fields at the top of the Email Client Template form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique template name.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that the template applies to. Enable the email client for the same table.</td>
</tr>
<tr>
<td>Conditions</td>
<td>The conditions that determine when this client template is used. Use the condition builder to identify the target record that must match before this template is applied to the email client.</td>
</tr>
<tr>
<td>Application</td>
<td>The type of scoped application.</td>
</tr>
<tr>
<td>Execution Order</td>
<td>A number that indicates the order in which template conditions are evaluated.</td>
</tr>
</tbody>
</table>
4. Fill in the fields in the **Content** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject</td>
<td>Enter a description of the email.</td>
</tr>
<tr>
<td>Content Type</td>
<td>Select the format of the message body content: HTML or plain text.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Body HTML</td>
<td>If you selected HTML for the <strong>Content type</strong>, enter the content of the message body using the HTML editor toolbar to format the HTML.</td>
</tr>
<tr>
<td></td>
<td>To reference field values, select variables from the variables list or manually type variable references using the syntax ${table_name.variable_name}. To reference the user who launches the email client, enter the variable ${current_user}.</td>
</tr>
<tr>
<td></td>
<td>You can call a mail script by using ${mail_script:script name} in the <strong>Body HTML</strong> field.</td>
</tr>
<tr>
<td>Body text</td>
<td>If you selected plain text for the <strong>Content type</strong>, enter any text or mail script that you want to appear in the message body.</td>
</tr>
<tr>
<td></td>
<td>You can insert a mail script in the <strong>Body text</strong> field by using the following syntax:</td>
</tr>
<tr>
<td></td>
<td><code>&lt;mail_script&gt; [code] &lt;/mail_script&gt;</code></td>
</tr>
</tbody>
</table>
5. Fill in the fields in the **Recipients** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td>Enter a comma-separated list of either field names that contain user email addresses or specific email addresses. To reference an email address using a script, create a script include and then call the script include in the <strong>To</strong> field. Your script must start with the <code>javascript:</code> prefix. The script must return email addresses in a comma-separated string.</td>
</tr>
</tbody>
</table>
| **Cc** | Enter a comma-separated list of either field names that contain user email addresses or specific email addresses. To reference an email address using a script, create a script include and then call the script include in the **Cc** field. Your script must start with the `javascript:` prefix. The script must return email addresses in a comma-separated string.  
This field cannot have the same addresses as the **To** field. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bcc</td>
<td>Enter a comma-separated list of either field names that contain user email addresses or specific email addresses. To reference an email address using a script, create a script include and then call the script include in the Bcc field. Your script must start with the javascript: prefix. The script must return email addresses in a comma-separated string. This field cannot have the same addresses as the To or Cc fields.</td>
</tr>
</tbody>
</table>

6. In the **Sender Configuration** tab, select the **From Generation Type** to determine how the sender (From address) in the email client message is generated.

Use this field only if you want a different From address than the one defined in your SMTP email account.

- **None**: The From address is not generated in the email client message.
- **SMTP Email Account**: Use the From address of the SMTP email account for the instance as the sender.
- **Select From List**: Choose from a list of allowable From addresses defined in the Email Client From Address [sys_email_client_from_address] table.
- **Script**: Run a GlideRecord query on the Email Client From Address [sys_email_client_from_address] table.

For example, the following script sets the From address based on the location of the incident caller:

```javascript
(function (fromAddressQuery, targetRecord) {
    // targetRecord is incident for this template
    var location = targetRecord.caller_id.country;
    if (location == 'us')
        fromAddressQuery.addQuery('email_address', 'servicedesk.us@example.com');
    else if (location == 'japan')
        fromAddressQuery.addQuery('email_address', 'servicedesk.jp@example.com');
    else if (location == 'uk')
        fromAddressQuery.addQuery('email_address', 'servicedesk.uk@example.com');
})(fromAddressQuery, targetRecord);
```

- **Text**: Enter the email From address to be used in the client.

**Note**: The From email address does not appear in the email client unless you configure email client to display the From address. For more information on managing the behavior of email client, see Email client configurations.

**Note**: If the domain for the From address is not the domain of the SMTP email account server, the owner of the From domain must configure the SPF record for the domain. The owner changes the domain settings to allow the instance to send email as if from that domain. For details on using SPF records, see ServiceNow KB0535456.
7. Click **Submit**.
   The template is added to the Email Client Templates [sys_email_client_template] table.

**SMS delivery with the email client**
A property is available that lets the user select an option to send a notification via SMS.
The **Subscription Based Notifications plugin** activates the following **system property**:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email_client.show_sms_option</td>
<td>Specify whether a check box appears in the email client for sending the message to the user's SMS device. If no SMS device exists, the email client sends the message to the primary email device.</td>
</tr>
</tbody>
</table>
Configuring the email client
Composing emails with quick messages
Insert predefined content into the message body of emails that you send from the email client.

Using quick messages

In the email client, you can select a quick message to fill the email body with the content that is specified in the quick message. After you define one or more quick messages, the Quick Message selector appears in the email client so that you can construct an email with multiple quick messages.

By default, the quick message content is inserted at the place of the cursor. It doesn't replace content that you created before selecting the quick message. To replace message content with a quick message, highlight the text to replace and then select a quick message.

Note: To instead have quick message content replace all existing content in an email draft, set the glide.email_client.quick_message.insert property to false.
Creating quick message content

Define quick messages by creating records in the Email Client Canned Messages [sys_email_canned_message] table.

When you define a quick message, you can add any of the following types of content into the message body:

• Icons
• Logos
• Pictures
• Rich-text HTML
• Hyperlinks
• Variables
• Any other HTML constructs

Note: If you add attachments to the quick message, the attachments are not sent as part of the email distribution.

Assign the email_client_quick_message_author role to business managers so that they can create quick messages for users in their group.

Setting quick message conditions

When you define a quick message, you can limit the availability of the quick message according to:

• The user who launches the email client
• The group of the user who launches the email client
• The table of the record from which you launch the email client
• The target record from which you launch the email client

For example, if you designate Beth Anglin as the user for a certain quick message, the quick message is available in the email client only for Beth Anglin.

If you associate a quick message to the Incident [incident] table, the quick message is available in the email client only after you launch from an incident record. If you specify a target record from the Incident table for the quick message, the quick message becomes available in the email client only for matching incident records.

Define a quick message

Create predefined content to add in the email client so that users can write emails consistently and efficiently.

Role required: email_client_quick_message_author or admin

1. Navigate to Email Client > Quick Messages.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name that appears in the Quick Message selector.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the quick message. When selected, the quick message is available for selection in the Quick Message selector.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Application</td>
<td>Type of scoped application.</td>
</tr>
<tr>
<td>User</td>
<td>User who has access to this quick message. Selecting a user restricts access to that user only. Leave the field blank to have no user-based restrictions.</td>
</tr>
<tr>
<td>Group</td>
<td>Group whose members have access to this quick message. Selecting a group restricts access to members of that group only. Leave the field blank to have no group-based restrictions.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the quick message applies. To make the quick message available for all tables, leave blank.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Target record that must match the conditions before the quick message appears for selection in the email client.</td>
</tr>
<tr>
<td>Body</td>
<td>Content to insert in the Message Text field in the email client. By default, the field supports HTML format. <strong>Note:</strong> To reference field values, select variables from the variables list or manually type variable references using the syntax <code>${table_name.variable_name}</code>. To reference the user who launches the email client, enter the variable <code>${current_user}</code>.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Email icon display**

You can use access control rules to hide or display the email icon on forms.

Users with write access to the current table can see the email icon. To remove the icon, remove the user's write access to the table. Typically you do this in one of two ways:

- Make the user an Employee Self-Service (ESS) user. ESS users do not have a user role, and without a role they do not have write access to the Incident table. Making a user an ESS users, therefore, hides the email icon on the Incident form.
- Create a custom ACL rule and user role that does not have write access to the table. The default ACL rule for the email client checks to see if the user has the itil role. If you grant users a custom role other than itil, then any such users will not see the email icon.

Remove or display the email icon for a table by setting the `email_client` dictionary attribute to true or false on the table’s collection record. This will not display the email icon for users without write access to the table. For more detail see Dictionary attributes.

**Email Service**

Email Service installs the Email API on the instance.

By default, Email Service only allows admin users to access the Email API. Administrators can grant access to the Email API by:
1. Adding an access control for creating records in the Email [sys_email] table linked to the email_api_send role.

2. Assigning the email_api_send role to the non-admin user.

3. Verifying the non-admin user has read access to the notification target table. For example, an email notification for an incident, requires read access to the Incident table.

Non-admin users with the email_api_send role can access the Email API from the REST API explorer.

Activate Email Service

Users with the admin role can activate the Email Service plugin (com.glide.email.service) to enable the Email API.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.

2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Grant access to the Email API

To grant non-admin users access to the Email API, administrators must create an access control and assign a special role.

Role required: admin

For additional details, see Email API.

1. Elevate privileges to security_admin.


3. Click New.

4. Create an access control for the Email [sys_email] table.

   Access control values

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>record</td>
</tr>
<tr>
<td>Operation</td>
<td>create</td>
</tr>
<tr>
<td>Admin overrides</td>
<td>Selected</td>
</tr>
<tr>
<td>Name</td>
<td>sys_email</td>
</tr>
<tr>
<td>Requires role</td>
<td>email_api_send</td>
</tr>
</tbody>
</table>

5. Assign the email_api_send role to the non-admin user.
6. Verify the non-admin user either has read access to all records in the notification target table or has read access to a specific record in the table. For example, to work with incident notifications the non-admin user needs access to the Incident table. You can provide record access by:

- Granting the user an appropriate role, such as the itil role.
- Selecting a specific incident that was opened on behalf of the user.

Troubleshooting notification emails

Logs and diagnostics are provided to help determine whether notification emails are being sent and received successfully, what any issues are, and who receives the email.

Diagnostics help monitor the overall health of the system and troubleshoot general problems, such as not receiving any incoming mail. Logs help identify problems with individual emails, and different logs are useful for diagnosing different types of problems.

Log checking scenarios

<table>
<thead>
<tr>
<th>Problem</th>
<th>Log</th>
</tr>
</thead>
<tbody>
<tr>
<td>Need to check whether an individual notification email was successfully sent</td>
<td>Check the <strong>Sent</strong> System Mailbox for that email. Also check the <strong>Failed</strong> System Mailbox for failure notifications.</td>
</tr>
<tr>
<td>Individual email failed</td>
<td>• Check the message log of the individual email.</td>
</tr>
<tr>
<td></td>
<td>• Check the <strong>Error string</strong> field of the email record.</td>
</tr>
<tr>
<td>Email not received by end user</td>
<td>• Check the <strong>Junk</strong> System Mailbox for notifications about returned emails. These emails also appear in the Emails log with a <strong>Type</strong> of received-ignored.</td>
</tr>
<tr>
<td></td>
<td>• Check the <strong>Error string</strong> field of the email record.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning:</strong> Some email servers do not return error strings</td>
</tr>
<tr>
<td></td>
<td>• Check the message log of the individual email for the reasons different recipients were included or excluded.</td>
</tr>
</tbody>
</table>

Troubleshooting resources

See the following resources on troubleshooting inbound and outbound email problems.
<table>
<thead>
<tr>
<th>Error or symptom</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance not receiving inbound email</td>
<td>See Inbound Email Troubleshooting, ServiceNow KB0524472. This KB article also provides links to a video series on troubleshooting inbound emails.</td>
</tr>
<tr>
<td>Instance not sending outbound email</td>
<td>See Troubleshooting Outbound Email, ServiceNow KB0521382. This KB article also provides links to a video series on troubleshooting outbound emails.</td>
</tr>
<tr>
<td>Email from Outlook produces an empty Incident record containing an attachment named winmail.dat.</td>
<td>Configure the local Outlook client or Exchange server to not send Rich Text formatted (RTF) data to the instance.</td>
</tr>
</tbody>
</table>

**Email diagnostics**

The Diagnostics and Connection page provides information on the current state of your email configuration. This page includes status on email properties, scheduled jobs, and email account connections that affect how your instance receives and sends email.

Email diagnostic information can help you identify problems with inbound or outbound email. The following video shows different steps to determine why your instance is not receiving inbound emails. One of the steps uses email diagnostics to check the email connection status and email reader scheduled job.

Navigate to the Diagnostics and Connection page from either of these modules:

- **System Mailboxes > Email Diagnostics**
- **System Diagnostics > Email Diagnostics**

**Email Diagnostics and Connection page**
Email Sending is Operational

- Email Sending Stats
  - Email Sending: Enabled
  - Email in Queue: 0
  - Last Sent Email: None

- SMTP Sender
  - SMTP Sender State: Ready
  - Processing Time: 16ms
  - Job Last Run: 2019-10-28 12:13:34

- SMS Sender
  - SMS Sender State: Ready
  - Processing Time: 3ms

Email Receiving is Non-Operational

- Email Receiving Stats
  - Email Receiving: Disabled
  - Last Received Email: None Received

- Email Reader
  - Email Reader State: Ready
  - Processing Time: 58ms
  - Job Last Run: 2019-10-28 12:13:08

Connection Status

<table>
<thead>
<tr>
<th>Status</th>
<th>Account</th>
<th>Type</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>ServiceNow SMTP</td>
<td>smtp</td>
<td>Connection Successful</td>
</tr>
<tr>
<td>●</td>
<td>Email POP3 password SSL</td>
<td>pop3</td>
<td>Inactive</td>
</tr>
<tr>
<td>●</td>
<td>Test Account</td>
<td>pop3</td>
<td>Inactive</td>
</tr>
<tr>
<td>✔️</td>
<td>ServiceNow POP3</td>
<td>pop3</td>
<td>Connection Successful</td>
</tr>
</tbody>
</table>

Related Links
- Modify Email Sending/Receiving
- SMTP Sender Job
- SMS Sender Job
- Email Reader Job
For quick status on a field, point to the green check mark or red X icon. The check mark icon indicates that the item is operational or healthy, while the X icon indicates that the item is not operational or within the expected range.

**Mail diagnostics**

<table>
<thead>
<tr>
<th>Diagnostic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email Sending is [Status]</strong></td>
<td></td>
</tr>
<tr>
<td>Email Sending</td>
<td>Status of outbound email as either Enabled or Disabled.</td>
</tr>
<tr>
<td></td>
<td>To change the status, click the Modify Email Sending/Receiving related link,</td>
</tr>
<tr>
<td></td>
<td>and in the Email Properties form, update the Email sending enabled property.</td>
</tr>
<tr>
<td>Email in Queue</td>
<td>Number of email messages that are ready to be sent.</td>
</tr>
<tr>
<td>Last Sent Mail</td>
<td>Date and time the last email message was sent.</td>
</tr>
<tr>
<td>SMTP Sender State</td>
<td>Current state of the SMTP Sender job, which sends email on a recurring</td>
</tr>
<tr>
<td></td>
<td>schedule. By default, this job runs every minute.</td>
</tr>
<tr>
<td></td>
<td>To update the SMTP Sender state, click the SMTP Sender Job related link,</td>
</tr>
<tr>
<td></td>
<td>and in the Schedule table, open the SMTP Sender record to be changed.</td>
</tr>
<tr>
<td>SMTP Processing Time</td>
<td>Duration of the last SMTP Sender job run. This value should be shorter</td>
</tr>
<tr>
<td></td>
<td>than the SMTP Sender interval.</td>
</tr>
<tr>
<td>SMTP Job Last Run</td>
<td>Date and time when the SMTP Sender job last ran.</td>
</tr>
<tr>
<td>Default SMTP Status</td>
<td>Indication of whether the SMTP connection was successful, shown only if</td>
</tr>
<tr>
<td></td>
<td>the email accounts feature is active.</td>
</tr>
<tr>
<td></td>
<td>Click Default SMTP to change your SMTP account settings.</td>
</tr>
<tr>
<td>SMS Sender State</td>
<td>Current state of the SMS Sender job, which sends SMS notifications on a</td>
</tr>
<tr>
<td></td>
<td>recurring schedule. By default, this job runs every minute.</td>
</tr>
<tr>
<td></td>
<td>To update the SMS Sender job, click the SMS Sender Job related link, and</td>
</tr>
<tr>
<td></td>
<td>in the Schedule table, open the SMS sender record to be changed.</td>
</tr>
<tr>
<td>SMS Sender Processing Time</td>
<td>Duration of the last SMS Sender job run. This value should be shorter than</td>
</tr>
<tr>
<td></td>
<td>the SMS Sender interval.</td>
</tr>
<tr>
<td>SMS Sender Job Last Run</td>
<td>Date and time when the SMS Sender job last ran.</td>
</tr>
<tr>
<td><strong>Email Receiving is [Status]</strong></td>
<td></td>
</tr>
</tbody>
</table>
## System email log and mailboxes

The system email log records all emails that the instance creates or receives. System mailboxes are filtered views of this log.

Every notification email that the instance creates or receives is recorded in an Email [sys_email] record. You can navigate to a log of these records at **System Logs > Emails**.

The System Mailboxes are filtered views of the Emails [sys_email] table. The instance assigns an email record to a system mailbox depending on the values of the **Type** and **State** fields. For more information, see **System mailboxes**.

The following fields can be included in the layout of the system log and any of the system mailboxes:

### Email log

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mailbox</td>
<td>The system mailbox that lists this email record. The instance sets the value of this field according to the values of the <strong>Type</strong> and <strong>State</strong> fields.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the email (Error, Ignored, Processed, or Ready).</td>
</tr>
<tr>
<td>Receive type</td>
<td>The type of inbound email (None, Forward, New, or Reply).</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>The status of the email. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• received: The server received this email.</td>
</tr>
<tr>
<td></td>
<td>• received - ignored: The server received this email, but it was ignored by the instance for inbound email action purposes. Typically, these emails are either spam or auto-replies. See the Error String field for details.</td>
</tr>
<tr>
<td></td>
<td>• send - failed: The server has attempted to send the email and failed. See the Error String field for details.</td>
</tr>
<tr>
<td></td>
<td>• send - ignored: The server skipped sending this email. Typically, this is for an email which was generated but lacked a recipient email address or is a duplicate email. See the Error String field for details.</td>
</tr>
<tr>
<td></td>
<td>• send - ready: The email is ready to be sent, but has not been sent out by the mail server. Typically, an email remains in this state for only a short time.</td>
</tr>
<tr>
<td></td>
<td>• sent: The email was sent by the instance without any errors or issues.</td>
</tr>
<tr>
<td>Target</td>
<td>A Document ID reference to the record if the email is generated by an insert, update, or delete of a particular record.</td>
</tr>
<tr>
<td>User</td>
<td>The name of the user, from the user record, of the instance from which the email notification was sent.</td>
</tr>
<tr>
<td></td>
<td>Note: This is a string field.</td>
</tr>
<tr>
<td>Notification Type</td>
<td>The type of notification. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td>• SMS</td>
</tr>
<tr>
<td></td>
<td>• SMTP</td>
</tr>
<tr>
<td>UID</td>
<td>The unique ID of the email stored on the server.</td>
</tr>
<tr>
<td>Created</td>
<td>The date and time of the email activity for the locale of the machine running the instance.</td>
</tr>
<tr>
<td>Deleted</td>
<td>For inbound email, indicates whether the email was deleted from the email server.</td>
</tr>
<tr>
<td>Weight</td>
<td>The weight of the email, which determines the sending priority relative to other notifications on the same table.</td>
</tr>
<tr>
<td>Importance</td>
<td>An indication that the email was sent with a changed level of importance, such as Urgent.</td>
</tr>
<tr>
<td>Originating Event and Notification</td>
<td>For emails generated by notifications, an embedded list that stores the event and notification that created the email.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Subject</td>
<td>The email subject. For notifications, you create the subject text in System Notification &gt; Email &gt; Notifications.</td>
</tr>
<tr>
<td>Error String</td>
<td>The error string captured from the email server to determine why the email was not sent. This is logged only if the email is send-failed.</td>
</tr>
<tr>
<td>Recipients</td>
<td>The email addresses of the recipients.</td>
</tr>
<tr>
<td>Body</td>
<td>The body of the email, displayed in raw HTML markup. Use the related link Preview HTML Body to see the body text as rendered HTML.</td>
</tr>
<tr>
<td>Content type</td>
<td>The email content type.</td>
</tr>
<tr>
<td>Headers</td>
<td>Any headers embedded in the email.</td>
</tr>
</tbody>
</table>

**Message logs for individual emails**

The email log entries for an individual notification email are accessible as a related list in the email record. The Error string field in the email record can provide additional information.

Every email record contains an Email Log related list. This list shows the Email Log Entry [syslog_email] records. For troubleshooting purposes, the most useful fields are probably Level and Message.

To diagnose problems with outbound emails, also examine the Error string field in the email record. However, not every receiving email server sends back an error string.

**Note:** The Email Log Entry record is available for only 7 days after the email record is created.

**Inbound actions on received emails**

Check these logs as the first step to diagnose issues with inbound actions. The logs show which inbound action did or did not apply and for what reason.

**Note:** If an inbound action did not update any field on the target record, the log indicates that the inbound action was skipped.
### Inbound email log

For outbound notifications, the email system log provides reasons that recipients were included or excluded.

Each log entry corresponds to a reason for inclusion or exclusion. For example, all users who were excluded because they are inactive appear in a single log entry.
A series of system properties can be used to fine-tune the information to be logged. Two master switch properties, `glide.notification.recipient.include_logging` and `glide.notification.recipient.exclude_logging`, control all recipient inclusion and exclusion logging. Several other properties allow you to tailor the information reported in the logs to meet your needs. All of the properties are enabled by default.

Outbound email log

Push notifications

In addition to sending email and SMS notifications, an instance can send push notifications to mobile devices.

A push notification is a text message that appears on a user's mobile device to alert them about something important or to ask them to perform an action. Your instance supports push notifications.
An example push notification

Use push notifications to send messages to users when certain conditions are triggered on your instance, such as the assignment of an incident to the user. A push notification can even ask for a reply, and the instance can process the reply by acting on the related records. For example, you can have the instance send an approval request for a Change to a user. You can let the user approve or deny the Change by clicking a response button on the push notification. The user's response can then update the status of the Change record.

You can set up push notifications in a similar manner to email and SMS notifications. Determine:

• who to send the notification to
• when it should be sent
• what it should contain

The ServiceNow mobile app is available as ServiceNow Classic and as ServiceNow Agent. By default, ServiceNow Classic supports push notifications, but you can also develop your own push application and configure your instance to send push notifications to it. For more information on setting up push notifications in ServiceNow Agent, go to Mobile push notifications.
Push notification setup

Push notification setup differs depending on the mobile or push application that you want your users to use. For an overview, see:

- **Push notification setup with the ServiceNow Classic mobile app**

  **Note:** Push notifications for on-premise instances are not supported.

- **Push notification setup with a custom push application.** If you create your own application, you must understand how push notifications and the Apple Push Notification Service system work. For more information, see the APNs Overview in the Local and Remote Notification Programming Guide for Apple developers.

  **Attention:** Apple does not guarantee delivery of all push notifications. Review the Quality of Service (QoS) information in the Local and Remote Notification Programming Guide for Apple developers.

Push notification system

The push notification system involves several key elements that manage the delivery of push messages and push notification responses.

**Customer instance**

Your ServiceNow instance.

**Push proxy**

An instance that collects all push notifications that go to the ServiceNow Classic mobile application and forwards them to the ServiceNow applications for Apple iOS or Android. If you create a custom push application, you do not use the push proxy.

**Push provider**

The provider of push messages, which is the Apple Push Notification service (APNs) or Firebase Cloud Messaging (FCM) service, for the ServiceNow Classic mobile app or custom mobile apps.

**Push application on a mobile device**

The application, such as the ServiceNow Classic mobile application. You can also build and customize your own push application.

Push notification process

The push notification process is as follows:

1. Activity on the instance triggers a push notification.
2. The instance looks for who to send the notification to and checks the user notification preferences to find their push device settings.
3. The instance sends the push notification to the push notification service, either the Apple Push Notification service (APNs) or Firebase Cloud Messaging (FCM) service. If you are using the ServiceNow Classic mobile app, the instance sends the notification through a push proxy instance, which then forwards the notification to the APNs or FCM service.
4. The push notification service sends the notification to the user's push application. When the instance sends the notification to the push notification service, it includes message content along with the instance name and ID. This information ensures that a response to the notification is sent back to the
correct instance. If the user can reply to the notification, such as sending an approval to a change request, the response is sent via REST message back to the instance.

5. The instance identifies a script to run to handle the response.

6. The script performs an action on the instance, such as marking a change request approved. If there is invalid JSON or if the script fails, an error response is sent back to the device.

**Push notification responses**

With custom push applications, you can have your users act on records in the instance by responding to a push notification.

The actions that they can take are defined in a script that you associate with the notification message. The response is sent to the instance in this format:

```
https://{instance_name}/api/now/v1/push/{application Name}/action/{action}
```

The application name is the push application the user is using. The application name must match the application name in the Push Application [sys_push_application] table. The action is the Sys ID of the action in the Push Notifications Actions [sys_push_notif_act_script] table.

**Activate push notifications**

Several plugins must be activated to use push notifications. If you have the Mobile UI (com.glide.ui.m) plugin active, push notification plugins are automatically activated.

Role required: admin

Ensure the following plugins are active on your instance:

- Push Notification: Provides the necessary components and REST APIs to send push notifications to mobile devices.
- Notification System Push Addon: Adds support for push notifications to the existing notification system.
- Push Feedback: Handles feedback from Apple on which devices are no longer valid so they do not keep receiving push notifications.

1. Navigate to **System Applications > All Available Applications > All.**
2. On the All Applications page, click **Request Plugin** to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>like this plugin to be enabled</td>
<td></td>
</tr>
</tbody>
</table>

*Note: Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

4. On the Activate Plugin request form, fill in the fields.

5. Click Submit.

**Installed with push notifications**

Several types of components are installed with the push notifications plugins.

**Tables installed with push notifications**

These tables are installed with push notifications.

<table>
<thead>
<tr>
<th>Table name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push Applications [sys_push_application]</td>
<td>Push applications registered to the instance to receive push messages.</td>
</tr>
<tr>
<td>Push Default Registrations [sys_push_notif_default_reg]</td>
<td>Contains all the notifications users are automatically subscribed to for a given push application. You can add notifications to this table on the Push Default Registrations related list on the Push Application form.</td>
</tr>
<tr>
<td>Table name</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Push Feedbacks [sys_push_feedback]</td>
<td>Feedback from the APNs that tells the instance which push devices can no longer receive push messages. The feedback is handled either on the same instance where your notifications are triggered, or on a central instance that uses a REST call to tell your instance which push applications to deactivate.</td>
</tr>
<tr>
<td>Push Message Attribute Definitions [sys_push_notif_msg_attr_def]</td>
<td>The attribute definitions used for push message content specification.</td>
</tr>
<tr>
<td>Push Message Attribute Values [sys_push_notif_msg_attr_val]</td>
<td>The values associated with push messages.</td>
</tr>
<tr>
<td>Push Notifications [sys_push_notification]</td>
<td>The push notifications that the instance attempted to send to users.</td>
</tr>
<tr>
<td>Push Notification Actions [sys_push_notif_act_script]</td>
<td>The action scripts that the instance uses in response to an actionable push message.</td>
</tr>
<tr>
<td>Push Notification Installations [sys_push_notif_app_install]</td>
<td>The devices with push apps where users agreed to receive push notifications. This table lists the records by the token for the push app. The instance uses this information to know which push device and app to send notifications to. Records are created in this table when a user logs on an instance with the push app. The Mobile Devices [sys_mobile_devices] table, which is installed with the Mobile UI plugin, contains all the user devices that logged in to the instance with the ServiceNow Classic mobile application.</td>
</tr>
<tr>
<td>Push Notification Messages [sys_push_notif_msg]</td>
<td>Messages customized for push notifications. These messages can be associated with a notification.</td>
</tr>
<tr>
<td>Push Notification Message Contents [sys_push_notif_msg_content]</td>
<td>The entire content, including JSON, for push messages.</td>
</tr>
<tr>
<td>Push Platforms [sys_push_platform]</td>
<td>The platforms that are supported for push notifications, and the maximum payload size.</td>
</tr>
</tbody>
</table>

### Business rules installed with push notifications

These business rules are installed with push notifications.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build Device and Subscriptions</td>
<td>Push Installation [sys_push_notification_installation]</td>
<td>Automatically creates a notification device on a user's notification preferences when the user registers a mobile application with the instance.</td>
</tr>
</tbody>
</table>

### Outbound REST messages installed with push notifications

These outbound REST messages are installed with push notifications.

<table>
<thead>
<tr>
<th>REST message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNowMobileApp Push</td>
<td>The REST message that you can use with your custom iOS mobile app.</td>
</tr>
</tbody>
</table>
Roles installed with push notifications

These roles are installed with push notifications.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>push_admin</td>
<td>Can create and modify push notifications.</td>
</tr>
</tbody>
</table>

Push components installed with push notifications

These components are installed with push notifications.

Push applications installed with push notifications

<table>
<thead>
<tr>
<th>Push application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNowPushApp</td>
<td>The push application record for the ServiceNow ServiceNow Classic mobile application.</td>
</tr>
</tbody>
</table>

Note: The ServiceNow Classic mobile app automatically subscribes users to several push notifications. You can see the list of these notifications in the Push Default Registrations related list on the ServiceNowPushApp application record.

Message content installed with push notifications

<table>
<thead>
<tr>
<th>Message content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConnectMessageContent</td>
<td>The payload for ServiceNow connect messages.</td>
</tr>
<tr>
<td>Generic Approval (Background)</td>
<td>The payload that provides an approval and rejection option to the user receiving the push message.</td>
</tr>
<tr>
<td>Generic Approval (Foreground)</td>
<td>The payload that provides an approval and rejection option to the user receiving the push message.</td>
</tr>
<tr>
<td>Generic Record Payload</td>
<td>A generic payload that you can use to send push messages to users.</td>
</tr>
</tbody>
</table>

Push notification actions installed with push notifications

<table>
<thead>
<tr>
<th>Push notification action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval - Approve</td>
<td>Allows an administrator to approve a request.</td>
</tr>
<tr>
<td>Approval - Reject</td>
<td>Allows an administrator to reject a request.</td>
</tr>
</tbody>
</table>

Push notifications installed with push notifications

<table>
<thead>
<tr>
<th>Push notifications</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConnectMessagePushNotification</td>
<td>Live Feed Message [live_message]</td>
<td>Sends a push notification when a new live feed message</td>
</tr>
</tbody>
</table>
Push notification properties

Push notifications provides several properties to customize the setup. Add these properties to the System Properties [sys_properties] table.

**glide.push.debug**

Creates entries in the system log for push notification errors.

- Type: true | false
- Default value: false

**glide.push.feedback.debug**

Creates entries in the system log for feedback sent by the APNs for custom iOS push applications.

- Type: true | false
- Default value: false

**glide.push.notification.ttl_seconds**

Specifies the number of seconds after which a queued push notification expires. After a push notification is triggered, it is queued and finally processed by a scheduled job. If the time the notification sits in the queue exceeds this value, the notification is not sent. Check the Push Notifications log for more information.

- Type: integer
- Default value: 21600

**glide.push.enabled**

Enables or disables push notifications.

- Type: true | false
- Default value: true

Push notification setup with the ServiceNow Classic mobile app

The ServiceNow Classic mobile application automatically enables push notifications and configures mobile devices for push notifications when users initially log in to the instance with ServiceNow Classic.

**Note:** Push notifications with the ServiceNow Classic mobile application are not supported in on-premise instances.

Setting up push notifications involves both the system administrator and users.

- Admin creates or updates push notifications for the ServiceNow Classic mobile app. The admin does not need to set up the mobile devices for users nor update their user preferences for receiving push notifications.
- Users install the ServiceNow Classic mobile app on their iOS or Android mobile devices and set their preferences for receiving notifications on the ServiceNow Classic mobile app.
What to do — admins

Admins create push notifications, similar to setting up email notifications. A push notification has two main parts: the push message and the notification, which includes the push message.

![Diagram showing the process of creating push notifications.]

**Note:** The push message and notification must be for the same table.

**Create the push message**

Before creating a push notification, create the push message with the actual message content (JSON payload) to be included in the push notification.

**Create the push notification that includes the push message**

Create the push notification that includes the push message and message content. A push notification specifically sends the push message. You can update a standard platform notification and use it as a push notification that includes the push message.

**Add the new push notification to the Push Default Registration table**
To ensure that a new push notification is included and enabled in the notification preferences of your users, register a new push notification in the Push Default Registration table. The notification is listed in the notification preferences of your users the next time that they log in to the ServiceNow Classic mobile app.

What to do — ServiceNow Classic mobile app users

Download the ServiceNow Classic mobile app

Install the ServiceNow Classic mobile app on an iOS or Android mobile device.

Agree to accept push notifications

After installing the ServiceNow Classic mobile app, users are asked to accept push notifications. When the instance receives the push notification acceptance message from a user, it creates a record in the Push Notification Installations [sys_push_notif_app_install] table. This record is what the instance uses to identify the device + mobile application combination necessary to identify a push notification recipient.

The device then performs the following actions:

• Obtains a token that identifies the device.
• Triggers the creation of the device in the user notification preferences.

Log in to the company instance from the ServiceNow Classic mobile app

Logging in automatically subscribes users to the push-specific notifications registered in the Push Default Registration table.

Update preferences for receiving notifications on the ServiceNow Classic mobile app

Users can enable or disable notifications through Notification Settings in the ServiceNow Classic mobile app. They can set additional notification preferences, such as conditions or filters that affect notification delivery, by using the System Settings window on a desktop or mobile browser. For details, see Setting notification preferences in UI16.

Next steps

If you are an admin, review the base system notifications and determine if new push message content and push notifications are needed.

Create a push message

Before you create a push notification, create the push message with the actual message content for the notification.

The Push notification plugin must be active. The plugin is active by default.

Role required: admin

The push message and notification must be for the same table.

2. Fill out the fields on the form (see table).
3. Click **Submit**.

**Push Notification Message form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the message.</td>
</tr>
<tr>
<td>Push App</td>
<td>Select the ServiceNow Classic mobile application.</td>
</tr>
<tr>
<td>Push Message Content</td>
<td>Select the JSON content to be included in the push notification payload.</td>
</tr>
<tr>
<td>Message</td>
<td>Enter the message. You can add variables just as you would for other notifications. Any message you enter here overrides the message in the notification.</td>
</tr>
<tr>
<td>Related list</td>
<td></td>
</tr>
<tr>
<td>Push Message Attribute Values</td>
<td>Optional. Select the attributes that apply to this notification. For details, see <a href="#">Create an attribute value or action for a push message</a>.</td>
</tr>
</tbody>
</table>

**Set up the push notification** that contains the message created or update an existing push notification to use the push message.

**Create a notification using a push message**

Email administrators can create a notification that specifically sends a push notification.

Configure the **push message** before performing these steps.

Role required: admin

You can associate a push message with a standard notification. A push message specifies the text the system sends as part of the push notification to the mobile device.

1. Navigate to **System Notification > Create Push Notification**.
2. Fill out the notification form as necessary (see [Create an email notification](#) for descriptions of the form fields).
3. Click the **What it will contain** tab.
4. Next to **Push Messages**, click the lock icon and select a push message.

**Note:** The push message and notification must be for the same table.

5. If you want this notification to be sent only as a push notification and not as any other type of notification, select **Push Message Only**.
6. Click **Submit**.

If the notification fails, the user is not notified. If the message fails to send because it exceeds the maximum payload, the instance logs the failure in the System Log.
Add the push notification to the Push Defaults Registrations table so that the push notification is listed in the notification preferences for users. Users can then select which notifications they want to receive for the ServiceNow Classic mobile app.

Add a push notification to the Push Default Registrations table

After you create a new push notification, add it to the Push Default Registration table. Push notifications registered in this table are listed and automatically enabled in the notification settings of your ServiceNow Classic mobile app users.

Role required: admin

2. Select the ServiceNow Classic Mobile Application.
3. In the Push Application form for the ServiceNow Classic mobile app, select the **Push Default Registrations** tab and click **New**.

4. In the Push Default Registration New record, select the notification to be registered.

5. Click **Submit**.

   The next time that users log in to their instance, the new push notification is included in their list of notifications.
Push notification setup with a custom push application

If you are using your own custom mobile or push application, you must configure your app for use and set up the push contents.

Setting up a push notification infrastructure that uses a custom push app involves a push admin (also called push app developer or mobile app developer) and system administrator. When push admins create a customized push app, they also configure the app, its push message content (payload generators), and optional attributes, such as push action scripts. The admin creates and updates the push notifications for the custom push app. After users install the custom push app and initially log in to their instance from their mobile device, the system automatically creates a device (channel) for the custom app.

Note: These instructions are intended for users who develop their own customized push application. You do not need to configure the ServiceNow Classic mobile application.
Before you begin

Assign the push_admin role to your organization's mobile app developer.

What to do — push admin

Configure push notifications for your custom push app. This process differs for iOS and Android devices.

1. (iOS only) Upload a push certificate to your instance

   Upload a push certificate to your instance so that you can use it later to connect your iOS device to the push notification system.
2. **Create a push application record for your custom app**
   Register your customized mobile application with your instance to receive push notifications for the application. The instance uses this push application record to identify the device + push application combination necessary to determine a push notification recipient.

3. **Create push message content**
   Create a JSON content payload for different types of push notifications. The content determines how a push notification appears on the push application, and whether the user can send a message in response to the push notification. The push admin can create attribute definitions that specify a default push action script or string, for use in the push message content.

4. **(Optional) Create a push message attribute definition**
   Push message attribute definitions allow you to create reusable properties for push message content specification.

5. **(Optional) Create an attribute value or action for a push message**
   You can create attribute values that override the default attribute definitions used in the push message content.

6. **(Optional) Create a push action**
   A push action is a server-side script that runs when the instance receives a response to an actionable push message.

### What to do — admin

**Create the push messages and push notifications**

The administrator creates the push messages, sets up push notifications for the custom push app, and if desired, the content.

### Next steps

Use the Push Installation API to opt users in to receive push notifications. For more information, see [Push Installation API](#)

**Upload a push certificate to your instance**

Upload a push certificate to your instance so that you can use it later to connect your iOS device to the push notification system.

Using your Apple developer environment, create a push certificate and convert it to a PKCS (.p12) file. For details on generating the .p12 file with the required certificate and private key, see [Enable push notifications](#) and [Communicate with APNs using a TLS certificate](#) in the Apple documentation.

**Note:** Ensure that your certificate is a push certificate and not a developer certificate. Also, if you're developing an app for testing purposes, ensure that you create a Sandbox certificate. If you're developing an app that you plan to launch in the Apple App Store, ensure that you create a Production certificate.

Role required: push_admin or admin
After you create a PKCS (.p12) file that contains the iPhone developer certificate and the private key used to sign the certificate, you need to upload the file to your instance. The system uses the information in the PKCS file to communicate with the APNs.

1. Navigate to System Definition > Certificates, and then click New.
2. On the form, fill in the following fields:
   - Name: Enter a certificate name.
   - Type: Select PKCS12 Key Store.
3. Attach the PKCS (.p12) file to the record.
4. Click Submit.

Create a push application record for your custom app

Create a push application record for your custom app

Register your customized mobile application with your instance to receive push notifications for the application.

Complete the following:

1. Activate push notifications
2. (iOS only) Upload a push certificate to your instance

Role required: admin or push_admin

Push notifications are application-specific: They are sent to one type of mobile application, regardless of how many users have this application installed. If you develop your own mobile application, you must configure it for use by creating a record for it in the Push Application [sys_push_application] table. By default, ServiceNow mobile applications are automatically set up and ready to use.

1. Navigate to System Notification > Push > Push Application, and then click New.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name of the push application.</td>
</tr>
<tr>
<td>Name</td>
<td>Database name of the push application. Enter a name that doesn't include spaces.</td>
</tr>
<tr>
<td>Push</td>
<td>Type of push service to enable for the application. Because you're setting up a custom push app, select Direct.</td>
</tr>
<tr>
<td>Feedback</td>
<td>Type of push feedback to use for the application. Because custom push apps don’t receive push feedback, select None.</td>
</tr>
<tr>
<td>Apple</td>
<td>Certificate</td>
</tr>
<tr>
<td></td>
<td>The X.509 certificate that you created on the Apple notifications portal. The certificate enables a device to talk to the APNs.</td>
</tr>
<tr>
<td></td>
<td>Sandbox Certificate</td>
</tr>
<tr>
<td></td>
<td>Sandbox certificate that you created on the Apple notifications portal. The certificate enables a device to talk to the APNs.</td>
</tr>
<tr>
<td></td>
<td>APNS Bundle Id</td>
</tr>
<tr>
<td></td>
<td>Bundle ID included in the certificate that you created on the Apple notifications portal. The system populates this field automatically after you specify a certificate.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### API key
FCM API key you obtained from Google for the Android push notification.

3. Click **Submit**.

**Create push message content**

Create push message content that contains the JSON content in the push notification payload.

In the Push Default Registrations related list, you can select the notifications that you want automatically subscribed to users who use this application. Users are subscribed to only active notifications.

**Create push message content**

Push message content specifies additional JSON content in the push notification payload that is sent to the push provider.

Complete the following:

1. **Activate push notifications**
2. **(iOS only)** Upload a push certificate to your instance
3. **Create a push application record for your custom app**

You must know how to use JSON with push messages.

**Role required: admin or push_admin**

Push message content defines the style of push notification that can be sent out for your custom app. You can add custom content, such as a picture, icons, or action buttons for the user to respond to the notification. Use the following variables in the script:

- **current**: properties of the current record.
- **message**: push message sent as the body of the entire push content.
- **attributes**: object of the push message attributes that you define.

1. Navigate to **System Notification > Push > Push Message Content**.
2. In the Push Notification Message Contents table, click **New**.
3. Fill out the fields on the Push Notifications Message Content form (see table).
4. Click **Submit**.

```javascript
(function buildJSON(xhrGlideRecords, current, message, attributes) {
    var json = {
        "aps": {
            "sound": "default"
        },
        "record": {
            "table": current.getTableName(),
            "sys_id": current.sys_id
        }
    };
    return json;
})(current, message, attributes);
```
Notification Message form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the message content.</td>
</tr>
<tr>
<td>Push app</td>
<td>The push application the content can be used with.</td>
</tr>
<tr>
<td>Push Message Generation</td>
<td>Enter a script that determines the message content. See the example scripts.</td>
</tr>
<tr>
<td>Related list</td>
<td></td>
</tr>
<tr>
<td>Push Message Attribute Definitions</td>
<td>Select the attributes that apply to this notification. Attributes can be a value or an action. These attributes are used as default values for the content items you create in the content script. However, any attributes you create with the push message can override these attributes. See Create a push message attribute definition for information on creating attributes.</td>
</tr>
</tbody>
</table>

The following is an example of a content record that creates a two-button layout, one to approve something, such as a change request, and one to decline it.

```javascript
var json = {
    "table" : current.getTableName(),
    "sys_id" : current.sys_id,
    "template" : {
        "type": "2 button",
        "button1" : {
            "title" : "Approve",
            "action" : attributes.button_action,
            "parameters" : { 
                "response" : "approve"
            }
        }
    },
    "button2" : {
        "title" : "Decline",
        "action" : attributes.button_action,
        "parameters" : { "response" : "decline"
    }
    }
};
json;
```

Define a push message attribute to specify a default push action script or string that you can use in the push message content.

Create a push message attribute definition

Push message attribute definitions allow you to create reusable properties for push message content specification.

1. Activate push notifications
2. (iOS only) Upload a push certificate to your instance
3. Create a push application record for your custom app
4. Create push message content

Role required: admin or push_admin

Use an attribute definition to specify a default push action script or string that you can then use in the push message content.

You can override these attributes by creating any push message attribute values.

2. Select a content record or script record.
3. In the Push Message Attribute Definitions related list, click New.
4. Fill out the fields on the form (see table).
5. Click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute Name</td>
<td>Enter a descriptive name for the layout.</td>
</tr>
<tr>
<td>Attribute Type</td>
<td>Select the type of attribute:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Action</strong>: An action to take on the instance, as defined by a script.</td>
</tr>
<tr>
<td></td>
<td>• <strong>String</strong>: An arbitrary string to send as part of the message content.</td>
</tr>
<tr>
<td>Content</td>
<td>Generic Record Payload</td>
</tr>
<tr>
<td>Default Script</td>
<td></td>
</tr>
</tbody>
</table>
If you want to override default attribute definitions, see Create an attribute value or action for a push message.

Create an attribute value or action for a push message

Attribute values are associated with push messages to provide a way for the message to include certain types of information in the push notification.

Complete the following:

1. Activate push notifications
2. (iOS only) Upload a push certificate to your instance
3. Create a push application record for your custom app
4. Create push message content
5. Create a push message attribute definition

Role required: admin or push_admin

These push message attribute values override values that you set in an attribute definition on the Push Content form.

2. Select a message.
3. In the Push Message Attribute Values related list, click New.
4. Fill out the fields on the form (see table).
5. Click **Submit**.

### Push Message Attribute Values form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>Select a push message attribute definition.</td>
</tr>
<tr>
<td>Value/Action</td>
<td>Enter the value for the attribute or select the push action. This field changes to Value or Action depending on the type of attribute you select in the Attribute field.</td>
</tr>
</tbody>
</table>

(Optional) Create a push action to perform an action on the instance.

### Create a push action

A push action is a server-side script that runs when the instance receives a response to an actionable push message.

Complete the following:

1. Activate push notifications
2. (iOS only) Upload a push certificate to your instance
3. Create a push application record for your custom app
4. Create push message content
5. Create a push message attribute definition
6. Create an attribute value or action for a push message

Role required: admin or push_admin

Create a push action to perform an action on the instance. For example, you might have an actionable push message that lets the user approve a change request. The action that handles the response should update the Approval field on the relevant Change Request record.

You can use global variables or, optionally, current variables and parameters passed through the JSON content.

2. Fill in the form fields (see table).
3. Click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the action.</td>
</tr>
<tr>
<td>Script</td>
<td>Enter the script.</td>
</tr>
</tbody>
</table>

Requeue failed push notification messages

Push notification delivery might fail for various reasons. You can view which messages failed and requeue them to be sent out if necessary.

Role required: admin

Note: There is no way for the instance to guarantee or confirm push message delivery. For more information on how Apple handles push notifications, see the Local and Remote Notification Programming Guide for Apple developers.

Messages can also fail to send for several reasons, such as a large message queue or other issue with the instance. You can use a system property to control how long the instance queues a push notification after it is triggered.

Push notification message payload size is limited by provider:

- Apple iOS: 2,048 bytes
- Google: 4,096 bytes
Your instance does not send push messages that exceed this limitation. System logs save any failed messages. For details on Apple payload limitations, see the Local and Remote Notification Programming Guide for Apple developers.

1. Navigate to **System Logs > Push Notifications**.
   By default, the messages that were created today appear. You can change the filter if necessary. The Type column can have these values:
   - **failure**: The message could not be sent.
   - **pending**: The message is queued for processing.
   - **success**: The message was successfully sent, although not necessarily received by the mobile device.

2. Put any failed messages back into the queue to be resent by selecting the check boxes next to the failed messages, and then selecting **Re-queue failed push notifications** from the choice list.
3. If some push notifications continue to fail, consider increasing the value in the `glide.push.notification.ttl_seconds` property. See Push notification properties for more information.

**Push notification retention**

You can archive and eventually destroy push notifications that you no longer need or if your Push Notification table is excessively large.

Push notification retention is available starting with the Jakarta release.

**Push notification archive and destruction plugins**

The push notification archiving and destruction feature uses the Data Archiving and Push Retention plugins. The Data Archiving plugin must be active to archive and destroy push notification records. The Push Retention plugin provides a set of rules that specify when the system archives and destroys push notification records.

In new instances, the Push Retention plugin and associated archive and destroy rules are active by default. On upgraded instances, you must manually activate both the plugin and the archive and destroy rules. Be sure to review and approve the archive and destroy rules before activating them.

If your instance already has a process for managing push notification records, you do not need to activate the Push Retention plugin. If you want to replace your current process with Push Retention, be sure to deactivate the current process before activating the archive and destroy rules.

**Archiving and destroying push notification records**

Archiving means moving records from the Push Notification [sys_push_notification] table to the Push Notification Archive [ar_sys_push_notification] table when they exceed the archive rule time limit. Destroying means deleting records in the Push Notification Archive table when they exceed the destroy rule time limit.

**Default archive and destroy rules**

Push retention provides the following push archive rules:

- **Push Notification - Over a year old**: archives push notification records that were created more than 365 days prior to the current date.
• **Push Notification Archive - Over a year old:** destroys push notification records that have been archived for more than 365 days prior to the current date.

With these default settings, your messages are kept on the instance for a total of two years: one year in the Push Notification table, and one year in the Push Notification Archive table. At the end of the period, the system deletes the expired notification records from the Push Notification Archive table.

**Note:** By default these rules are active on new instances and inactive on upgrades. The system runs archive and destroy rules when you activate them.

**Compatibility with other record management implementations**

If you are already using another method for managing push notification records, such as table cleaners, you do not have to use the Push Retention feature. To prevent unexpected record deletion, avoid using multiple push notification management processes on the same instance at the same time.

**Note:** For assistance replacing your existing record management implementation with push notification retention, contact your professional services or sales representative.

**Activate the Push Retention plugin**

The Push Retention plugin (com.glide.push_retention) provides the retention policy for push notifications, so that you can specify when the system archives and destroys push notification records.

Role required: admin

The Push Retention plugin requires the Data Archiving plugin.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Archive push notifications manually**

You can manually archive push notifications on demand instead of waiting for the instance to archive them based on a scheduled job.

Role required: admin

Push retention provides these push notification archive rules:

• **Push Notification - Over a year old:** archives push notification records that were created more than 365 days prior to the current date.

• **Push Notification Archive - Over a year old:** destroys push notification records that have been archived for more than 365 days prior to the current date.
You can manually archive push notification messages that meet the default archive and destroy rules or any additional archive rules that you create.

1. Navigate to **System Archiving > Archive Rules**.
2. Open the push notification archiving rule, for example Push Notification - Over a year old
3. Click **Recalculate Estimate** to see how many records in the Push Notification [sys_push_notification] table are going to be archived. The estimate appears in the **Record estimate** field.
4. Click **Run Archive Now**.

**Subscription-based notifications**

Subscription-based notifications enable users to proactively subscribe to items that interest them and unsubscribe from messages that are not mandatory.

Users can also specify additional notification channels that each of their notifications can be configured to use.

Before users can manage the notifications that are sent to them, administrators must create email notifications to which users can subscribe. Administrators can also make subscription-based notifications mandatory so users cannot unsubscribe to them. Then users can subscribe or unsubscribe to the notifications, and add schedules and filters to the subscription to limit the notifications that can be received.

Notifications that administrators mark as subscribable are automatically available in user notification settings. Users are limited to one subscription per notification.

Administrators should create subscription-based notifications when they do not want to specify users for a notification and want to let users proactively subscribe to the notification.

**Note:** Subscription-based notifications are not domain aware and cannot support domain-specific settings.

**Subscriptions 2.0 plugin**

The Subscription Based Notifications 2.0 plugin must be active to use subscribable notifications. This plugin is active by default on all new and upgraded instances.

The plugin installs the Notification Subscription [sys_notif_subscription] table, which holds user subscriptions to all notifications.

**Subscriptions and notification preferences**

Users can subscribe to notifications available to them through their notification preferences. In the UI16 interface, all users can set and modify their notification preferences through the **Notifications** tab of the System Settings window. In the UI15 interface and earlier, admins and users set their notification preferences through the **Notification Preferences** link in the User form.

**Setting notification preferences in UI16**

You can set your own notification preferences, including personal subscriptions and channels for receiving them. All users can set these preferences through the **Notifications** tab of the System Settings window.

With the **Notifications** tab, you can:

- Search for a specific notification in the list of your notifications.
- Use a global switch to enable or disable all your notifications.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• Enable or disable a particular channel for receiving notifications, as well as create, edit, or delete channels.
• Control the notifications that you receive and apply conditions to restrict notification delivery.
• Create personal notifications, which are subscriptions to notifications that are important to you.

Comparison between notification preferences in UI16 and earlier interfaces

In new and upgraded instances that use the UI16 interface, the System Settings window is the central location for managing your notification preferences. The Notification Preference User Interface (com.glide.notification.preference.ui) plugin is activated by default.
Notification preferences in UI16 and UI15

In UI15 and earlier interfaces:

- Users set notification preferences through the **Notification Preferences** link in the User form (Self service > My Notification Preferences).
• Admins created user devices and set notification preferences for users through the **Notification Preferences** link in the User form, accessed through the User Administration module (User Administration > Users).

**Note:** Admins can revert to the UI15 notification preferences interface by setting the `glide.notification.preference.UI.enabled` property to false.

### Manage your notification preferences in UI16

To access your notification preferences, click the gear icon (⚙) in the banner frame, and in the System Settings window, click the **Notifications** tab. You can also access the System Settings by navigating to Self Service > My Notification Preferences.
In the **Notifications** tab, use the following settings to manage your notifications:
### ServiceNow    DocVersion    Now Platform capabilities

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Search</strong></td>
<td>Search bar for finding notifications.</td>
</tr>
<tr>
<td></td>
<td>To find a notification:</td>
</tr>
<tr>
<td></td>
<td>• Enter the name of the notification you are searching for. When you type the first three characters, the system automatically returns a list of notifications matching the characters entered.</td>
</tr>
<tr>
<td></td>
<td>• Enter two asterisks to return a list of all notifications in alphabetic order (the notifications are not organized by category).</td>
</tr>
<tr>
<td><strong>Allow notifications</strong></td>
<td>Global switch for enabling or disabling all notifications.</td>
</tr>
<tr>
<td><strong>Notification channels</strong></td>
<td>List of your channels for receiving notifications. Use this section to:</td>
</tr>
<tr>
<td></td>
<td>• Enable or disable a channel by using its toggle switch. If you disable a channel, notifications are not delivered through that channel.</td>
</tr>
<tr>
<td></td>
<td>• Add channels using the <strong>Create Channel</strong> option.</td>
</tr>
<tr>
<td></td>
<td>• Modify channel information. Click the channel row or the right arrow (►) next to the appropriate channel to edit or delete it.</td>
</tr>
<tr>
<td><strong>Notifications by category</strong></td>
<td>List of notification categories that identify and group related notifications. Each category contains the notifications that you can subscribe to.</td>
</tr>
<tr>
<td></td>
<td>To view the notifications in a given category, click the category row or the right arrow (►) next to the appropriate category. You can:</td>
</tr>
<tr>
<td></td>
<td>• Edit settings for a notification:</td>
</tr>
<tr>
<td></td>
<td>• Enable or disable channels for the selected notification.</td>
</tr>
<tr>
<td></td>
<td>• Apply notification conditions, such as schedules and filters, that affect the delivery of the notification.</td>
</tr>
<tr>
<td></td>
<td>• Create personal notifications, which are subscriptions to specific notifications that matter to you.</td>
</tr>
</tbody>
</table>

### Create notification channels

You can add channels to receive your notifications. A notification channel is an email account or voice message system that you have access to.

**Role required:** none

Notification channels include email addresses, service providers for SMS messages, and mobile applications. You can create voice notification channels to support applications like Notify.

**Note:** If you are using the ServiceNow mobile application or a custom push application, you do not need to create a push channel for your mobile device. The system automatically creates a channel for the mobile app after you initially log in to your instance from your mobile device.

1. Click the gear icon 🔄 in the banner frame to open the System Settings window, and click the **Notifications** tab.
2. Click **Create Channel**.
3. Complete the fields on the New Channel form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for the channel, such as the device or email account.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Type</td>
<td>The type of channel:</td>
</tr>
<tr>
<td></td>
<td>• Email: for email messages.</td>
</tr>
<tr>
<td></td>
<td>• SMS: for SMS messages.</td>
</tr>
<tr>
<td></td>
<td>• Voice: for phone messages.</td>
</tr>
<tr>
<td></td>
<td>Note: All users with an email address have a primary email channel, which is created automatically after a notification is sent to them.</td>
</tr>
<tr>
<td>Email address</td>
<td>The email address of the channel.</td>
</tr>
<tr>
<td>Phone number</td>
<td>The phone number for SMS messages or for voice messages.</td>
</tr>
<tr>
<td>Service provider</td>
<td>The service provider for SMS messages.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

The system creates and enables the channel, and adds it to the list of notification channels.

To receive notifications on your new notification channel, you must enable the channel for individual notifications. After you enable the channel for a notification, you can set conditions to further control the notifications that you receive on the channel. For more information, see **Apply notification conditions**.

**Modify notification channels**

You can update channel information for your notifications.

Role required: none

1. Click the gear icon (⚙️) in the banner frame to open the System Settings window, and click the **Notifications** tab.
2. In the Notification Channels section, click the channel row or the right arrow (>) next to the channel name.
3. In the Edit Channel form, update the fields (see **Create notification channels** for descriptions of the form fields).
4. Click **Save**.

The system updates and saves the channel information that you modified.

**Delete a notification channel**

Delete a notification channel so that you no longer receive notifications through the channel.

Role required: admin

1. Click the gear icon (⚙️) in the banner frame to open the System Settings window, and click the **Notifications** tab.
2. In the Notification Channels section, click the channel row or the right arrow (>) next to the channel name.

3. On the Edit Channel form, click **Delete**.

The system deletes the channel from the list of notification channels and no longer delivers notifications to that channel.

**Apply notification conditions**

You can set various conditions and filters to control the notifications you receive. You can also enable or disable an email digest and the delivery of individual notifications by channel.

Role required: none
You can choose to enable certain features and set different conditions that control the notifications you receive. You can:

- Enable or disable an email digest if a digest is available for the notification. An email digest is a single email that summarizes the activity for the notification during a time interval that you specify. Admins configure the email digest content for a notification.
- Enable or disable a channel on which the notification is received.
- Set preconfigured schedules and filters that determine when you receive your notifications.
- Set more advanced filter conditions to limit the notifications delivered to you.

1. Click the gear icon (⚙️) in the banner frame to open the System Settings window, and click the **Notifications** tab.
2. Select the notification:
   a) In the Notifications By Category section, click the row or right arrow (›) of the category that you want to view.
   b) In the list of notifications for the category, click the row or right arrow (›) next to the notification that you want to edit.
3. To enable or disable an email digest for the notification, if an email digest is available:
   a) Click the **Email Digest** switch.
      The email digest is enabled when the switch is green and disabled when the switch is grey.
   b) If you enabled the digest, select the **Interval** (length of time) during which the notifications are accumulated.

The interval begins with the first occurrence of notification activity during the specified interval. For example, if you selected the Daily interval and the first notification occurs at 07:00, the system begins accumulating notifications at 07:00 and stops at 07:00 the next day. Soon after the interval ends, the system sends the email digest instead of sending the individual notifications that were triggered during the digest interval. If you disabled the digest, the system immediately stops accumulating the notifications and does not send the email digest.

4. To enable or disable a channel on which the notification is received, click the switch for the channel. The notification is enabled when the switch is green and disabled when the switch is grey. If you previously disabled an entire channel, you cannot enable that channel for the notification.
5. To set more criteria for notification delivery, click the row or the right arrow (>) next to the channel for the notification.
   a) Complete the Apply Conditions form (see table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule</td>
<td>Select a schedule that determines when the notification can and cannot be received.</td>
</tr>
<tr>
<td>Filter</td>
<td>Select a pre-configured filter with the criteria that determines when the notification can be sent. For example, you might select a filter whose conditions send notifications when an incident with a priority of 1 - Critical is opened for a network issue.</td>
</tr>
<tr>
<td>Advanced filter</td>
<td>Select this check box to use the condition builder to create additional criteria. When you select the check box, the Table and Conditions fields are displayed.</td>
</tr>
</tbody>
</table>
Create personal notifications

You can create personal notifications, which are subscriptions to notifications of importance to you. You can apply conditions that control specific content included in your personal notification, and also enable or disable the channels for delivery.

Role required: none

A personal notification is a subscribable notification that you can customize. You can assign the notification a name that is meaningful to you and filter the information received in that notification.

**Note:** Users are limited to one subscription per notification.

1. Click the gear icon (🔧) in the banner frame to open the System Settings window, and click the **Notifications** tab.
2. Click **Create Personal Notification**.

b) Click **Save**.

To navigate back, click the left arrow («) at the top of the Notifications window.
3. Complete the New Personal Notification form (see table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for your personal notification. Use a meaningful name to distinguish it from system notifications.</td>
</tr>
<tr>
<td>Notification</td>
<td>The notification to subscribe to. You can subscribe only to notifications that are configured to allow subscriptions. Depending on the notification you select, the Table, Affected record, and Send when fields are displayed.</td>
</tr>
<tr>
<td>Table</td>
<td>The database table that the notification is linked to.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Affected record</td>
<td>The specific record that the notification is based on. This field appears when you select a notification that has an affected record (for example, a notification for a problem record that has multiple affected CIs). Click the lookup icon, select the table and specific document (record) in that table, and click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Send when</td>
<td>Another condition that must be met to send the notification. For example, you might create a filter whose conditions send notifications when an incident with a priority of <strong>1 - Critical</strong> is opened for a network issue.</td>
</tr>
</tbody>
</table>
4. Click **Save**. The system creates the personal notification and adds it to the appropriate notification category.

In the following example, notice the category in which the system placed the personal notification.

![Notification Category Example](image)

5. Enable or disable the channels for your personal notification.
6. Navigate back to the list of notifications for the category by clicking the left back arrow («) at the top of the form. Notice that your Personal Notifications are listed above the System Notifications in the given category.

![Notification Preferences](image)

7. Navigate back by clicking the left back arrow («) at the top of the form or by clicking the **Notifications** tab.

**User notification preferences in UI15 and earlier**

In UI15 and earlier interfaces, use the **Notification Preferences** link in the User form to manage the notifications that you can subscribe to.

The following instructions explain how to use **Notification Preferences** to manage notifications.

**Set up a notification device in UI15 and earlier**

You can add devices for a user to receive notifications. A **device** is a mobile device, email account, or voice message system that the user has access to.
Role required: admin

Notification devices include email addresses, service providers for SMS messages, and mobile applications.

1. Navigate to **User Administration > Users**.
2. Select a user.
3. Click **Notification Preferences**.
4. Click **Create New Device**.
5. Fill in the fields on the form (see table).
6. Click **Submit**.

### New Device form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name of the device or account.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of device:</td>
</tr>
<tr>
<td>Email address</td>
<td>The user's email address.</td>
</tr>
<tr>
<td>Mobile app</td>
<td>The mobile application for push notifications.</td>
</tr>
<tr>
<td>Phone number</td>
<td>The user's phone number for SMS messages.</td>
</tr>
<tr>
<td>Service provider</td>
<td>The service provider for SMS messages.</td>
</tr>
<tr>
<td>User</td>
<td>The user's record in the system.</td>
</tr>
<tr>
<td>Order</td>
<td>A number that determines which device receives the notification when multiple devices are configured. The device with the lowest number receives the notification.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>A flag that indicates if the device is active.</td>
</tr>
<tr>
<td>Related list</td>
<td></td>
</tr>
<tr>
<td>Notification Device Variables</td>
<td>Additional, optional attributes of an SMS device used inside an advanced script from the SMS service provider. These attributes are generally used to deliver SMS notifications to an internal SMS distribution technology. This advanced scripting procedure is not necessary for configuring external SMS providers.</td>
</tr>
</tbody>
</table>

**Note:** If you inactivate a device, it still appears in the user preferences, but the switches that allow users to select the notifications are grayed out for that device column.

**Edit a notification device in UI15 and earlier**
All users can edit their notification preferences, including notification devices.

Role required: none

1. Navigate to **Self-Service > My Profile**.
2. Click **Notification Preferences**.
3. Click the name of the existing device.

The device form opens allowing you to make certain modifications, depending on your user role. See **Set up a notification device in UI15 and earlier** for a description of all fields.

**Add personal subscriptions in UI15 and earlier**

After setting up your devices, you can subscribe to notifications that are configured as subscribable.

The Subscription Based Notifications 2.0 plugin must be active.

If you have subscribed to messages, your list of notification messages can build over time. You can create preferences for how and when these messages are delivered, or unsubscribe to messages that are not configured as mandatory.

**Note:** Conditions that you apply to personal subscriptions do not override the filters that the administrator creates for the subscribable notifications. Your conditions are evaluated after the conditions on the subscribable notification are met. If the notification filter set by the administrator fails, the filter conditions on your personal subscription are not evaluated.

1. Navigate to **Self-Service > My Profile** to open your user profile.
2. Click the **Notification Preferences** related link.
   The Notification Preferences page opens. You can see your personal subscriptions and the general notifications that you are subscribed to.
3. Click **Subscriptions**.
4. Click **Add Personal Subscriptions**.
5. Fill in the fields as described in the table.

Add personal subscriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for the subscription.</td>
</tr>
<tr>
<td>Notification</td>
<td>The notification to subscribe to. You can only subscribe to notifications that are configured to allow subscriptions.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that the incident is configured to run on. You cannot modify the table from this form. To select another table, configure the notification. See Create an email notification.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box indicating whether the subscription is active. Users can receive notifications for subscriptions only if the subscription is active. If it is not active, the on-off switch for the subscription is set to off and is read-only.</td>
</tr>
<tr>
<td>Send to</td>
<td>The devices that this subscription is sent to. Selecting the devices in this field is the same as turning on the switch for the subscription on the Subscriptions page.</td>
</tr>
<tr>
<td>Affected record</td>
<td>The specific record that the subscription is based on. Click the lookup icon, and then select the table and the specific record in that table.</td>
</tr>
<tr>
<td>Send when</td>
<td>Another condition that must be met to send the notification. For example, you might select a filter whose conditions send notifications when an incident with a priority of 1 - Critical is opened for a network issue. The system evaluates the conditions in this filter after the conditions set in the notification filter by the administrator.</td>
</tr>
</tbody>
</table>
6. Click **Submit**.
7. You can turn the subscription for active subscribable notifications on or off using the switch on the Subscriptions management section of the Notification Preferences page.

   ![Subscription table](image)

   **Personal subscriptions**

   Personal subscriptions are saved in the Notification Subscriptions [sys_notif_subscription] table. The records in this table are made active or inactive when you click the switch to subscribe or unsubscribe from the notification.

8. You can edit the subscription at any time by clicking **Edit** next to it.

### Select notifications in UI15 and earlier

Administrators can configure notification preferences for each user and users can also select which notifications they want to receive for various devices.

1. Navigate to **Self-Service > My Profile** to select your own notifications, or if you have admin access, navigate to **User Administration > Users** to select notifications for another user.
2. Click a user record to open it.
3. On the User form, click **Notification Preferences** under Related Links.

   The notification preferences page appears. The preferences pages show all the notifications available to the user and the devices that the user has configured, such as email or mobile phone. If a user
does not have read access to the table on which the notification is based, the notification does not appear.

Every user has the Primary email device, where subscriptions to email notifications can be enabled.

4. Click the switch next to the notification to subscribe the user to it.

Modify notifications for a user device in UI15 and earlier

After you set up the devices through which users receive notifications, you can assign the notifications to each device and add advanced conditions to limit what notifications are received.

Role required: admin

1. On the Notification Preferences page for a user, find the notification from the list of notifications.
2. Click Edit next to the notification. The preferences for that notification appear.
3. Fill in the fields on the form (see table).
4. Click Submit.

**Notification preferences for a user’s device**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification Message</td>
<td>Select the notification. Related fields appear for certain notifications. For example, if you select CI affected or Location affected, a field appears for selecting the CI or the location. Duplicate messages are not permitted on a device.</td>
</tr>
<tr>
<td>Device</td>
<td>Modify the device if necessary.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Select a schedule that determines when the notification can and cannot be received.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Filter</td>
<td>Select a pre-configured filter with the criteria that determines when the notification can be sent. For example, you might select a filter whose conditions send notifications when an incident with a priority of 1 - Critical is opened for a network issue. The system evaluates the conditions in this filter after the conditions in the notification filter set by the administrator. This field is not available when an advanced filter is configured.</td>
</tr>
<tr>
<td>Advanced filter</td>
<td>Select this option if you want to use the condition builder to create additional criteria. When you select the check box, the Table and Conditions fields replace the Filter field.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table for the notification. For example, if you select the CI affected notification message, you might select the Incident [incident] or Change Request [change_request] table. This field appears when you check the Advanced filter check box.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Define as many conditions as needed to limit the notifications you receive.</td>
</tr>
</tbody>
</table>

**Create a service provider**

Administrators can configure service providers for devices that use SMS.

**Role required: admin**

Administrators also have the option of configuring how a device's service provider affects the construction of the device's email address.

1. Navigate to the Notification Service Provider [cmn_notif_service_provider] table by typing `cmn_notif_service_provider.list` in the application navigator filter.
2. Fill out or change the fields on the form (see table).
3. Click Update.
4. Click **Save** on the Notification Preferences page.
<table>
<thead>
<tr>
<th>Name</th>
<th>AT&amp;T</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>SMS</td>
</tr>
<tr>
<td>Active</td>
<td>Yes</td>
</tr>
<tr>
<td>Application</td>
<td>Global</td>
</tr>
<tr>
<td>SMS Provider Email Prefix</td>
<td></td>
</tr>
<tr>
<td>SMS Provider Email Suffix</td>
<td>txt.att.net</td>
</tr>
<tr>
<td>Advanced notification</td>
<td>No</td>
</tr>
<tr>
<td>Construct address manually</td>
<td>No</td>
</tr>
</tbody>
</table>

Update  Delete
### The Notification Service Provider form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Configured name of the service provider.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of device, in this case SMS.</td>
</tr>
<tr>
<td>Active</td>
<td>Enables or disables this notification device.</td>
</tr>
<tr>
<td>Advanced notification</td>
<td>Removes all the previous options and displays the Advanced script field.</td>
</tr>
<tr>
<td>Advanced script</td>
<td>Used for custom notifications that run a script rather than construct a traditional SMS/email. This is generally used when all outbound SMS messages must run through a central SMS hub, as opposed to being sent directly from the instance to the SMS provider. Advanced users can construct a script in this field that will send a notification to an old style numeric pager that cannot receive SMS communications. This field is rarely used and employs advanced scripts. Contact your representative to assist you with any advanced SMS scripting.</td>
</tr>
<tr>
<td>Construct address manually</td>
<td>Removes the prefix and suffix options and displays the Construction script field.</td>
</tr>
<tr>
<td>Construction script</td>
<td>Allows you to script the email address construction as you would in a business rule. For example, [abc + current.phone_number + <a href="mailto:def@text.att.net">def@text.att.net</a>] would construct an email address of <a href="mailto:abc2223334444def@text.att.net">abc2223334444def@text.att.net</a>. <strong>NOTE:</strong> Current is a reference to the device, not the service provider, hence the current.phone_number variable that uses the device's phone_number value.</td>
</tr>
<tr>
<td>SMS Provider Email Prefix</td>
<td>Places the provided text before the device's specified phone number; for example: <a href="mailto:PREFIX2223334444@text.att.net">PREFIX2223334444@text.att.net</a></td>
</tr>
<tr>
<td>SMS Provider Email Suffix</td>
<td>Places the provided text after '@' sign; for example: 2223334444@SUFFIX</td>
</tr>
<tr>
<td>Notification Device Variables</td>
<td>Additional, optional attributes of an SMS device used inside an SMS service provider's Advanced script. This is generally used to deliver SMS notifications to an internal SMS distribution technology. This is an advanced scripting procedure and is not necessary for configuring external SMS providers.</td>
</tr>
</tbody>
</table>

### Select a service provider

You can configure how a device's service provider affects the construction of the device’s email address.

**Role required:** admin

1. **Navigate to** User Administration > Users and open any user's record.
2. Under Related Links, click Notification Preferences, and then click an SMS notification device.
3. If no SMS device is present, click **New Device** and configure one.
4. Select the appropriate service provider, and then click the reference icon for the **Service provider** field. The service providers are saved in the Notification Service Provider [cmn_notif_service_provider] table. Only active providers are visible.

**SMS notification advanced scripting**

You can use these objects and their attributes in your advanced notification scripts on the SMS Notification Service Provider form.

**Objects and attributes**

<table>
<thead>
<tr>
<th>Object</th>
<th>Example attributes</th>
</tr>
</thead>
</table>
| current | • current.number  
          • current.assigned_to  
          • current.company  
          • current.state |
| email   | • email.notify  
          • email.sourceTable  
          • email.contentType  
          • email.attachments  
          • email.HTML  
          • email.dataVersionHeader  
          • email.UID  
          • email.allowSavingNoRecipientEmail  
          • email.recipients  
          • email.ignore  
          • email.save  
          • email.headers  
          • email.sysId  
          • email.attachmentLimits  
          • email.class  
          • email.sysId  
          • email.textBody  
          • email.hashCode  
          • email.weight  
          • email.equals  
          • email.logEmail  
          • email.reset  
          • email.wait  
          • email.body  
          • email.SMSText  
          • email.watermark  
          • email.textBodyLegacy  
          • email.sourceHeader  
          • email.subject  
          • email.instance  
          • email.importance |
### Make a notification mandatory

To prevent users from turning off or deleting a subscription to a notification, make the notification mandatory.

**Role required: admin**

When you make a notification mandatory, the notification is locked in user notification preferences, preventing the user from removing or unsubscribing to the notification, filtering it, or changing the schedule. Users receive mandatory notifications even if they disable notifications.

**Note:** Mandatory notifications apply to only the primary device of the user. You cannot make a notification mandatory for secondary devices.

1. Navigate to **System Notification > Email > Notifications**.
2. Open the appropriate notification.
3. Configure the form and add the **Mandatory** field. This field does not display by default.
   a) Click the context menu icon ( ) and select **Configure > Form Layout**.
   b) Using the slushbucket, select the **Mandatory** field and the order in which you want the field to appear.
   c) Click **Save**.

<table>
<thead>
<tr>
<th>Object</th>
<th>Example attributes</th>
</tr>
</thead>
</table>
| device | • device.service_provider  
• device.group  
• device.order  
• device.sys_id  
• device.sys_updated_by  
• device.sys_created_by  
• device.primary_email  
• device.schedule  
• device.name  
• device.sys_created_on  
• device.email_address  
• device.active  
• device.phone_number  
• device.sys_mod_count  
• device.sys_updated_on  
• device.user  
• device.sys_meta  
• device.type |
4. Select the **Mandatory** check box.

When a user checks their notification preferences, the control button for the mandatory notification is on and is read only.

---

**Force a notification to be sent**

To force a notification to be sent to the specified users, enable forced delivery.

Role required: admin

Forcing a notification means that the relevant users receive the notification, even if they have not subscribed to the notification or have turned off the subscription. In addition, the users receive the notification even if the **Notification** field is set to **Disable**.
**Note:** Forced delivery applies to only the primary device of the user. You cannot force a notification to be sent to secondary devices.

1. Navigate to **System Notification > Email > Notifications**.
2. Open the appropriate notification.
3. Configure the form and add the **Force delivery** field.
4. Select the **Force delivery** check box.
5. Click **Update**.

Unlike using the **Mandatory** option, forcing the delivery does not lock the user's preference or prevent the user from unsubscribing from the notification.

### Create a notification filter

Notification filters enable a user to control the delivery of messages by creating special conditions on multiple tables in a single, reusable filter.

Role required: admin

For example, you can create a filter that controls message delivery when active incidents, problems, and change requests for network issues reach a critical state. For UI15 and earlier interfaces, notification filters are available for selection in the **Filter** field of a user's Notification Preferences form. For UI16, filters for notifications or channels are set through the Notifications tab of the System Settings window. For details, see **Apply notification conditions**.

**Note:** The system applies the user's filter conditions after the administrator's conditions have been evaluated. If the administrator's conditions fail, the system ignores notification filters.

1. Navigate to **System Notification > Email > Notification Filters** and create a record.
In the **Notification conditions** related list of the new record, create and submit filter conditions on one or more tables.
3. Repeat the procedure to create additional conditions on other tables for this filter.

Filter device notifications using a schedule

You can associate devices, such as Email, SMS, and Voice, to schedules that define when the devices can and cannot receive notifications.

Role required: admin

Notifications that are triggered outside of the scheduled days and times for the device are not queued up for delivery at a later time. For example, if an administrator selects the **Weekdays** schedule for an email
device, the device receives email notifications triggered between Monday and Friday. If notifications are triggered on Saturday, they are not delivered to the device.

1. Define schedules as needed using **System Scheduler > Schedules > Schedules**.
2. Add or edit a device.
3. Configure the New Device for System Administrator form and add the **Schedule** field.
4. In the **Schedule** field, select the schedule for the device.
5. Click **Submit**.

**Edit the schedule or filter of an existing notification message**

You can update a schedule or filter that was previously created for an email notification.

Role required: admin

To edit the schedule or filter of an existing notification message:

1. In the Notification Preferences screen, click the message to edit.
   You cannot edit any attributes of a mandatory message.
2. Make the appropriate changes in the form.
3. Click **Update**.

**Email unsubscribe**

Administrators can add unsubscribe links to notifications so that users can stop receiving particular email messages.

*Note:* The base system notifications include unsubscribe and notification preferences links.

The system offers two types of macros to create unsubscribe links.
- An unsubscribe link that creates an email message to the instance.
- An unsubscribe link that opens the notification preferences for the user on the instance.

**Available unsubscribe macros**

<table>
<thead>
<tr>
<th>Unsubscribe type</th>
<th>Macro used</th>
<th>Description</th>
<th>Available parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsubscribe by email (Unauthenticated)</td>
<td>${NOTIF_UNSUB}</td>
<td>The system generates an HTML mailto hyperlink. When users click the link, their browser or email client creates a pre-formatted unsubscribe email message to the instance.</td>
<td><strong>link_text</strong>: specify the text to display as a link within quotation marks.</td>
</tr>
<tr>
<td>Unsubscribe by notification preferences (Authenticated)</td>
<td>${NOTIF_PREFS}</td>
<td>The system generates an instance link directly to the notification preferences for this notification type.</td>
<td><strong>link_text</strong>: specify the text to display as a link within quotation marks.</td>
</tr>
</tbody>
</table>

Administrators can add unsubscribe macros to any notification record type such as:
- Email layouts
- Email templates
- Email notifications

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Unsubscribe by email

Unsubscribe by email requires the user email client or browser to create a pre-formatted email message containing these elements:

- The **To** field has the email address of the instance.
- The **Subject** starts with the string **Unsubscribe from**.
- The **Body** has a JSON string with a name-value pair of **Unsubscribe** and an array value that contains two more name-value pairs.
  - The **notification_id** parameter specifies the Sys ID of the notification the user wants to unsubscribe from.
  - The **unsub_token** parameter specifies an instance ID the system uses to verify that the email came from a ServiceNow instance.

**Note:** Some email clients and web browsers, such as GMail on Chrome, require extra client configuration to support mailto hyperlinks. Administrators can provide an alternative unsubscribe method for users whose email client or browser does not support mailto links. See RFC6068 for information about the mailto URI scheme.

The **Unsubscribe from Notification** inbound action processes the email and unsubscribes the sender from the listed notification.

**Note:** Unsubscribing by email message does not require users to authenticate with the instance first.

Unsubscribe by notification preferences

Unsubscribe by notification preferences requires the user’s browser to navigate to the notification preferences page on the instance. After logging in, the system displays the notification preferences for this particular notification.

Users can set preferences for this notification such as disabling notifications for a particular device. Users must save their notification preferences for changes to take effect.

Unsubscribe links

This email layout adds several unsubscribe links to the bottom of each email notification.

```text
${NOTIF_UNSUB} from this notification by email or ${NOTIF_UNSUB
+link_text="click here"}. Manage your ${NOTIF_PREFS} or ${NOTIF_PREFS+link_text="click here"}.
```

When rendered in an email notification, the unsubscribe links only display the link text.
Notification Preview

Preview records for this breakdown source

<table>
<thead>
<tr>
<th>Event Creator</th>
<th>Preview Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fred Luddy</td>
<td>INC0000060</td>
</tr>
</tbody>
</table>

Users

Beth Anglin

Subject

Incident INC0000060 commented

Body

You can view all the details of the incident by following the link below:

Go to Instance

Unsubscribe | Manage Preferences
If a user clicks the **Unsubscribe** link, the email client creates a message such as this:

![Unsubscribe email message](image)

**Sample unsubscribe by email message**

**Notifications in messaging applications**

Enable users to receive their ServiceNow platform notifications in Slack or Microsoft Teams messaging applications. Use the Now Actions app to configure the messaging apps for your instance.

**Admin setup**

To enable ServiceNow notifications within Slack or Teams, you must be an administrator for both ServiceNow and the third-party application.

1. **Request IntegrationHub**

   Integrations with third-party systems require a separate IntegrationHub subscription. To activate IntegrationHub, see [Request an IntegrationHub plugin](#).

2. **Request the Messaging Notification plugin**
To activate this feature, request the Messaging Notification plugin (com.glide.notification.messaging) through the HI Customer Service system. This plugin activates related plugins if they are not already active.

3. Install the Now Actions messaging app for Slack or Teams

As an administrator for both ServiceNow and the third-party application, find and install the Now Actions app. Install the application in ServiceNow to associate the app with your instance.

**Note:** The primary owner of a Slack workspace or organization owns and manages the application. To avoid losing admin access to the workspace or organization, transfer primary ownership before any administration changes occur. If you transfer primary ownership, update the JSON payload for the Slack installation in the Notification Integration page. For more information about editing the Slack installation, see Install the Now Actions messaging app.

If the Now Actions app is uninstalled, the workspace or team displays as inactive in the Notification Integration page. To view the Notification Integration page, navigate to System Notification > Messaging > Messaging Integration Configuration.

4. Configure message content

Create a message in the Message Contents [messaging_content] table that you can use in multiple notifications. Messages can be informative, or they can request action from an individual Slack or Teams user. For example, the Approval Request message includes Approve and Reject buttons to take the associated action in ServiceNow. Only users that have linked their Slack or Teams account with their ServiceNow account can take action in ServiceNow from the third-party application.

5. Create a messaging notification

Notifications define when a message is sent, who it is sent to, and what it contains. To send a notification to Slack or Teams, add a messaging content record to the notification and configure the notification messaging channel. Notifications that require action must be sent to individual users instead of groups.

**User setup**

To enable individual ServiceNow notifications in Slack or Teams, and to take action on notifications, configure your system settings and link your user accounts.

**Link your ServiceNow user account to your Slack or Teams account**

Link your ServiceNow account to your Slack or Teams account to take action on ServiceNow notifications from within Slack or Teams. If you do not link accounts, you can still receive notifications within group channels. However, you cannot to approve ServiceNow requests or take action on notifications from within Slack or Teams.

**Configure system settings**

Each user can enable ServiceNow notifications in a third-party application by configuring the communication channel in their system settings. Opt in to receive approval requests and other actionable notifications in third-party channels.

**Notification channels**

In ServiceNow, a notification channel is a method or device for receiving notifications. For example, in the base system you can elect to receive notifications through email or SMS channels. If messaging
When applications are enabled on your instance, you can enable notifications to Slack and Teams using Notification Channels in your system settings.

**Actions and events**

The Message Actions [messaging_observer_handler] table processes communication channel events, such as adding or deleting a Slack channel, to keep the instance and the third-party application in sync. Only developers creating Slack or Teams applications should add actions to this table. Register new actions with the instance through the Message Event Registry [messaging_observable] table. To remove a base system action, clear the active flag instead of deleting the record.

**Logging**

The Inbound and Outbound message logs contain information on actions, events, and activities between ServiceNow and the third-party application. Use the logs to identify the content, state, and origin of communications to and from your instance.

**Request the Messaging Notification plugin**

To activate this feature, request the Messaging Notification plugin (com.glide.notification.messaging) through the HI Customer Service system. This plugin activates related plugins if they are not already active.

Role required: admin

There are two ways to request a plugin:

- Access the HI Service Catalog directly by clicking Service Catalog > Activate Plugin on HI.
- Access the HI Service Catalog through the All Applications page on your instance by following these steps.

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click **Request Plugin** to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

### Install the Now Actions messaging app

As an administrator for both ServiceNow and the third-party application, find and install the Now Actions app. Install the application in ServiceNow to associate the app with your instance.

To activate this feature, request the Messaging Notification plugin (com.glide.notification.messaging) through the HI Customer Service system. This plugin activates related plugins if they are not already active. For more information, see Request the Messaging Notification plugin.

**Note:** To Install the Now Actions messaging app for Slack, the version of your instance should be either of the following

- Orlando Patch 9 (or above)
- Paris Patch 4 (or above)
Roles required:
- Admin or messaging_admin in ServiceNow
- Administrator for Slack or Teams

**Install the Now Actions messaging app for Slack**

Install the Now Actions messaging app from the Slack App Directory and associate the app with your instance.

1. Install the Now Actions app from the Slack App Directory.
   a) Find and install the Now Actions app in the Slack App Directory.
   b) Click Authorize when prompted.
   c) Enter a customized name, app description, and icon (optional).
   d) Configure your Now Actions web address. This is the base URL for your instance. For example, `https://<instance_name>.service-now.com/`.
   e) Copy the JSON configuration found in the **Add your Slack credentials to your app** section for use in later steps.

2. Associate your Slack app with your instance.
   a) Navigate to **System Notification > Messaging Integration Configuration**.
   b) Click the **Install** button next to Slack.
   c) In the JSON Configuration pop-up, paste in the JSON configuration you copied in earlier steps.

3. Check for installation verification. The Slack workspace should appear below the Slack heading on the Notification Integration page.

   During installation, the instance synchronizes with all public Slack channels in the workspace. New public channels added after installation will automatically synchronize with the instance. You can browse to **System Notification > Messaging Channels** on your instance to verify that the new channel appears on the instance.

   To update the app after installation, use the **Configure JSON Payload** and **Settings on Slack** icons on the Notification Integration page. You can view the JSON payload, view app credentials, change app appearance, or delete the app.
Install the Now Actions messaging app for Microsoft Teams

Associate the Now Actions messaging app with your instance.

1. Associate your Microsoft Teams app with your instance.
   a) Navigate to **System Notification # Messaging Integration Configuration**.
   b) Click the **Install** button next to Microsoft Teams.
   c) A pop-up message appears to confirm redirection to Microsoft Teams to verify your identity. Click **OK**.
   d) When prompted, log in to Microsoft Teams with your Teams admin account.
   e) Click **Accept** to accept the permissions for the app.
f) If the selected workspace has already been assigned, you are asked whether you want to proceed to overwrite the previous assignment. Click **Override** to change the workspace, or click **Cancel** to leave the current assignment in place.

g) After authentication, installation will start in the background. Once installation completes, a message appears confirming the installation.
h) Click the **app package** link to access a knowledge base article [KB0690098](#), containing the application package for Microsoft Teams. Follow the steps in the article to make this package available for your Microsoft Teams users.
2. Check for installation verification. The new team should appear below the Teams heading on the Notification Integration page.

During installation, the instance synchronizes with all public Teams channels. To add channels created after the install, open Microsoft Teams and @mention the app from the new channel. You can browse to System Notification > Messaging Channels on your instance to verify that the new channel appears on the instance.

To receive a ServiceNow notification in Microsoft Teams, create a message and a notification. See Configure message content and Create a messaging notification.

Configure message content

Create a message in the Message Contents [messaging_content] table that you can use in multiple notifications. Messages can be informative, or they can request action from an individual Slack or Teams user. For example, the Approval Request message includes Approve and Reject buttons to take the associated action in ServiceNow.

Role required: admin or messaging_admin

To enable users to take actions in Slack or Teams, use the Buttons message type and define scripted behavior. Only users that have linked their Slack or Teams account with their ServiceNow account can take action in ServiceNow from the third-party application.

1. Navigate to System Notification > Messaging Content.
2. Open an existing notification record or click New to create a new record.
3. Fill in or modify the fields as appropriate.

<table>
<thead>
<tr>
<th>Messaging content fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>Target table</td>
</tr>
<tr>
<td>Fields</td>
</tr>
<tr>
<td>Message heading</td>
</tr>
<tr>
<td>Message</td>
</tr>
<tr>
<td>Buttons</td>
</tr>
<tr>
<td>Script</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Application</td>
</tr>
</tbody>
</table>

4. Click Submit

This example shows the output of a message in Microsoft Teams. This message is of the buttons type, which shows buttons and performs scripted actions based on the user selection. In this case, the script uses the sn_notification.Messaging.send method to display the change in state for the record.
Use the message in a notification. For more information about creating notifications, see Create a messaging notification.

**Create a messaging notification**

Notifications define when a message is sent, who it is sent to, and what it contains. To send a notification to Slack or Teams, add a messaging content record to the notification and configure the notification messaging channel. Notifications that require action must be sent to individual users instead of groups.

Role required: admin

2. Click New.
3. Fill in or modify the fields as appropriate.

### Messaging notification fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the notification. Use descriptive names to ensure that your users are able to easily distinguish between notifications.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table to trigger the message. Must be a table or database view within the same application scope.</td>
</tr>
<tr>
<td>Note:</td>
<td>Notifications running on the task [task] table are not supported. Instead, use a table extended from task.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category for the notification. A category groups related notifications in the system settings.</td>
</tr>
<tr>
<td>Note:</td>
<td>Do not leave the category as Uncategorised, as users may not be able to find the notification in their list of notifications.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for this notification.</td>
</tr>
</tbody>
</table>

**Note:** Notification records are shared between messaging, email, and push notifications. Some fields on the form are not relevant to messaging notification records. Leave fields not described here at their default values.

4. Click **Advanced view** under **Related links** to switch the advanced view. Switching to the Advanced view saves the current record.
5. Open the **When to send** tab and complete the form.

![Notification Configuration](image)

**Note:** If the same trigger generates multiple notifications, the system only sends one notification. The system considers all other notifications, even if they have a different subject and body, as duplicates. The Ignore Duplicates business rule controls this functionality.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Send when</strong></td>
<td>Select under what condition the notification is sent:</td>
</tr>
<tr>
<td></td>
<td>• When a record is inserted or updated</td>
</tr>
<tr>
<td></td>
<td>• When a particular event is fired</td>
</tr>
<tr>
<td></td>
<td>• When <strong>triggered as an action step</strong> in Flow Designer</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Weight | Set a numerical value for the notification priority relative to other notifications with the same target table and recipients. The system only sends the notification with the highest weight. The default value 0 causes the system to always send the notification (assuming the conditions are met).

Conditions | Use the condition builder to select the conditions under which this notification is sent. For example, select `Priority > greater than > 3 - Moderate` to send the notification only for High and Critical priority incidents.

Inserted | Select the check box to enable messaging notification when a record is inserted. This field appears when you set the `Send when` field to `Record inserted or updated`.

Updated | Select the check box to enable messaging notification when a record is updated. This field appears when you set the `Send when` field to `Record inserted or updated`.

Event name | Select the event that triggers this notification. This field appears when you set the `Send when` field to `Event is fired`.

Advanced condition | Create a script to define more filter conditions, like sending a notification based on the current messaging record, changing field values, or changing system properties.

The advanced condition script must return `true` or set a global answer variable to `true` to send the notification.

The advanced condition script uses the following global variables:
- `current`: Contains the current record from the table to which the notification is linked.
- `event`: Contains the event that triggered the notification.

**Note:** The Advanced condition field is evaluated in addition to other conditions you set on the notification. Both the condition and advanced condition must evaluate to true to send the notification.

6. Open the **Who will receive** tab and fill in or modify the following fields.

### Field | Description
---|---
Messaging Channels | Select the messaging channels to receive the messaging notification. Only complete this field if creating a simple notification to send to a channel. Simple notifications use a Messaging Content record of Type **Simple**.
7. Open the **What it will contain** tab and fill in or modify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messaging content</td>
<td>Select a messaging content record to be used in this notification.</td>
</tr>
</tbody>
</table>

8. Click **Update**.
Link your ServiceNow user account to your Slack or MS Teams account for Now Actions

Link your ServiceNow account to your Slack or Teams account to take action on ServiceNow notifications from within Slack or Teams. If you do not link accounts, you can still receive notifications within group channels. However, you cannot to approve ServiceNow requests or take action on notifications from within Slack or Teams.

Role required: none

1. Open the Slack or Teams application
2. Find the Now Actions bot. This bot is found in the left panel of Slack under Apps, and in the left panel of Teams in the Chat tab.
3. Start a conversation with the Now Actions bot. The bot then presents a link to authenticate.

![Authentication message]

4. Click the Connect to ServiceNow link.

A new browser tab opens and prompts the user to Deny or Confirm the connect between your Slack or Teams account and your ServiceNow account. This link will expire five minutes after it is displayed.
5. Click **Confirm** to link the accounts.

6. After confirmation, you are directed to the instance user record. A confirmation message is displayed at the top of the screen.

**Configure system settings**

Each user can enable ServiceNow notifications in a third-party application by configuring the communication channel in their system settings. Opt in to receive approval requests and other actionable notifications in third-party channels.

You can only enable notifications in notification channels you have permission to access.

1. Select the gear icon in the banner frame to access the System Settings window.
2. Select the Notifications tab.
3. Under Notification Channels, enable notifications for the desired channels.

### NOTIFICATION CHANNELS

<table>
<thead>
<tr>
<th>Channel</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ Create Channel</td>
<td></td>
</tr>
<tr>
<td>Primary email</td>
<td></td>
</tr>
<tr>
<td>Slack - docteam</td>
<td></td>
</tr>
<tr>
<td>Teams - snnotifications.onmicrosoft.com</td>
<td></td>
</tr>
</tbody>
</table>

### Notification Channels in System Settings

4. Opt in to individual notifications.

To receive notifications for Button type messages, you must opt in for each individual notification that you wish to receive. For example, to receive an approval request as a direct message in Slack, you must find the notification and set the Slack workspace as an enabled channel for that specific notification.

**Note:** To receive notifications for Simple type messages, you need only to enable the notification channel. You don't need to opt in for individual notifications. For more information on message types, see Configure message content.

a) In the Notifications by Category section, select the category containing the notification you want to enable. The category is defined on the notification record.

You can also search notifications to find individual notifications by name.

b) Select the notification you wish to enable a channel for.

c) Enable the notification channels where you want to receive this notification.

### Unlink your ServiceNow user account from your Slack or MS Teams account for Now Actions

Unlink your ServiceNow account from your Slack or MS Teams account to stop receiving actionable ServiceNow notifications in Slack or Teams.

Role required: none
If you unlink your account to a messaging app for Now Actions, you must also disable the corresponding messaging channel in your notification preferences.

1. Navigate to **Self-Service > My Profile**.
2. Click the **View Linked Accounts** related link.
3. In the Linked Accounts page, check the selection box for the messaging integration to be unlinked.
4. Select **Actions on selected rows...**, then click **Unlink account**.

Your ServiceNow account is unlinked from the Now Actions messaging integration (the link is inactive).

**Note:** Even though you unlinked your account, you still receive notifications in any group channels to which you belong.

5. Disable the messaging channel in your Notification Preferences.
   a) Select the gear icon in the banner frame to access the System Settings window.
   b) Under Notification Channels, disable the appropriate messaging channel.

**Note:** If you want to link your ServiceNow account again, follow the steps in **Link your ServiceNow user account to your Slack or MS Teams account for Now Actions**.

### Email digests

An email digest is a single email that summarizes the activity for a selected notification and its target record during a specified time interval. You can enable an email digest to reduce the number of notifications received when frequent updates to the associated record occur within a short time period.
Example email digest

Note: Email digests apply to email notifications only and are not supported for SMS messages, push notifications, and activity streams.

How email digests work

In new and upgraded instances, the Email digest (com.glide.email_digest) plugin is activated by default. Your instance must use the UI16 interface, since the email digest feature involves setting user notification preferences in the System Settings window.

Admins determine which notifications can be delivered in an email digest and configure the digest content for those notifications. Admins can also control the intervals for digests. An interval is the length of time that notifications are collected for the digest, such as daily or hourly.
Users enable the digest and select the digest interval for a specific notification in their notification preferences. The system accumulates the notifications that normally would be sent during the specified interval and summarizes them in the email digest.

When processing an email digest, the system:

- Stores the digest configuration for the notification in the Notifications [sysevent_email_action] table.
- Temporarily stores the notification content accumulated for a user in the Email Digest Parts [sys_email_digest_part] table and the Email Digest Part Users [sys_email_digest_part_user] table.
- Runs an email digest job every 15 minutes to check when a digest is ready to be sent to a user.

The system uses the digest interval to determine when the digest is ready to be sent. The digest interval begins when the first notification is triggered for the user and stops at the end of the interval time.

- Sends the email digest to the user soon after the selected digest interval ends.

For example, if a user selects an hourly digest interval and the first notification is triggered at 08:15, the interval starts at 08:15. When the digest interval ends, the system generates the email digest approximately one hour later, at about 09:15 or shortly after, depending on when the email digest job ran.

**Set up email digests**

**What to do — admins**

1. Review the base system digest intervals and if needed, create or modify intervals.
   
   The base system digest intervals are one day (24 hours), one hour, every four hours, and seven days (weekly).

2. Determine the email notifications that can be delivered in a digest and configure the email digest content for those notifications.

   When determining which notifications are appropriate for an email digest, consider the notification content and intervals that your users can select. For example, digests that can be generated weekly might be better suited for notifications that are non-urgent.

**What to do — all users**

For a notification that can be delivered in an email digest, enable the email digest in your notification preferences (Notifications tab in the System Settings window). You also specify the interval time that the notifications are accumulated.

**Next step**

If you are an admin, begin the digest setup process by reviewing the base system email digest intervals and create or modify the intervals.

**Create or modify email digest intervals**

Admins can create or modify the email digest intervals (length of time) during which activity for a selected notification is accumulated in an email digest. Users select a digest interval when they enable an email digest in their notification preferences.

Role required: admin
Before adding an email digest interval, review the base system digest intervals in the Digest Intervals [sys_email_digest_interval] table. You can modify intervals, including the base system intervals, which are one day (24 hours), one hour, every four hours, and seven days (weekly).

1. Navigate to System Notification > Email > Digest Intervals.

2. Enter the new or changed interval information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Interval name that describes the interval length of time, for example: Every 2 hours.</td>
</tr>
<tr>
<td><strong>Interval</strong></td>
<td>Length of the interval, either number of Days or Hours (hours, minutes, and seconds). The minimum time length allowed is one hour, and the maximum time length allowed is seven days (one week).</td>
</tr>
</tbody>
</table>
3. If you created an interval, click **Submit**. Or, if you changed an interval, click **Update**.
The system updates the Digest Intervals [sys_email_digest_interval] table with the new or modified interval. The digest interval is listed as an option in the notification preferences (Notifications tab in the System Settings window) when a user enables a digest for the notification. For example:

![Image of System Settings]

4. To delete an interval, select the interval to be deleted in the Digest Intervals [sys_email_digest_interval] table and click **Delete**.

**Note:** If the interval is in use, the system does not remove the interval.

Determine the email notifications that can be delivered in a digest and configure the email digest content for those notifications.
Configure email digests

Use the Notification form to create or modify the content of an email digest for a notification. You can also disable the email digest for a notification so that it is not available in the notification preferences of your users.

Role required: admin

When you create or update a notification, use the What Digest will contain tab of the Notification form to configure the email digest for the notification. After you define the digest content, the digest option for the notification is available in the notification settings of your users.

1. Navigate to System Notification > Email > Notifications.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are creating a notification</td>
<td>Click New to open the Notification form.</td>
</tr>
<tr>
<td>If you are modifying a notification</td>
<td>Select the notification to be changed.</td>
</tr>
</tbody>
</table>

2. In the Notification form, select the Allow Digest check box to display the What Digest will contain tab and define the digest content.
3. Complete the fields in the **What Digest will contain** tab. The example shows the default view of the tab. The advanced view contains additional fields (see table).
<table>
<thead>
<tr>
<th>When to send</th>
<th>Who will receive</th>
<th>What it will contain</th>
<th>What Digest will contain</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digest Template</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digest Subject</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digest HTML</td>
<td></td>
<td></td>
<td>Select variables:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digest Separator</td>
<td>(HTML)</td>
<td></td>
<td>Select variables:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Digest Template</strong></td>
<td>If you want to reuse existing content, such as headers or footers, select an email template to add content to the email digest.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Digest Subject</strong></td>
<td>Enter the subject line for the email digest. The subject can include variables from the <strong>Select variables</strong> column.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>If empty, the system uses the <strong>Subject</strong> value from the <strong>Email template</strong>. If you enter a value in this field, it overrides the template value.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Digest HTML</strong></td>
<td>Enter the recurring content for the email digest. The digest content can include variables from the <strong>Select variables</strong> column.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Variables map to column names available from the notification table, its parent tables, and reference tables. Use variables to include values from a record in the table such as an incident short description or comments and work notes.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>To prevent adding extra <code>&lt;p&gt;</code> and <code>&lt;div&gt;</code> elements to your email digest, see the blog post <em>Extra line spacing with paragraph tags in email client</em> by a ServiceNow employee in the ServiceNow Now Community.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Digest Separator (HTML)</strong></td>
<td>Use the line to separate each item summarized in the digest.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Digest From</strong></td>
<td>Enter the email address to be used in the From field of the email digest. For example, <a href="mailto:helpdesk@yourcompany.com">helpdesk@yourcompany.com</a>. The email address must be in a valid format, otherwise a notification message appears near the field.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Changing this address requires an advanced email setup such as enabling email forwarding.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Digest Reply To</strong></td>
<td>Enter the email address that you want people to use when replying to the email digest. For example, <a href="mailto:helpdesk@yourcompany.com">helpdesk@yourcompany.com</a>. The email must be in a valid format, otherwise a notification message appears near the field.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Changing this address requires an advanced email setup such as enabling email forwarding.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Digest Text</strong></td>
<td>Enter the recurring content of the email digest to send in plain text. This field appears when you set the content type to <strong>HTML and plain text</strong> or <strong>Plain text only</strong>.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Digest Separator (text)</strong></td>
<td>[Optional] Use the dash character as a line to separate each item summarized in the digest. This field appears when you set the content type to <strong>HTML and plain text</strong> or <strong>Plain text only</strong>.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
4. When you finish creating the notification, click **Submit**. Or, if you are done modifying the notification, click **Update**.

The email **Digest** option is displayed in the notification settings of your users.

**Note:** The email recipients identified in the **Who will receive** tab will receive the digest after they enable the digest in their notification preferences. If the user is not a designated recipient for the notification, a digest is not generated even though the user may have the digest enabled for a notification. In this case, the user receives the actual notifications when they are generated.

5. [Optional]. To disable the email digest for a notification, unselect the **Allow Digest** check box and click **Update** when you finish your changes to the notification.

When you disable the digest content, the digest option is also no longer available for the notification and is not listed in the notification preferences for your users. If a user previously enabled the digest option for the notification, the system stops collecting those notifications for a digest and does not generate the digest.

**Note:** If you disabled the digest and want to make the digest available again, select the **Allow Digest** check box. The system retains the previously saved digest content and displays it in the **What Digest will contain** tab.

---

**Enable an email digest**

In your notification preferences, you can enable an email digest that summarizes the activity for a selected notification during a specified time interval. The digest is a single email that you receive instead of the individual notifications generated during the specified interval.

**Role required:** none

The email digest option is available for a notification (in your notification preferences) only when your admin has configured the email digest content for that notification.

Consider enabling an email digest to reduce the number of emails you would normally receive when the target record for a notification is frequently updated within a short time period.

1. Click the gear icon (⚙️) in the banner frame to open the System Settings window, and click the **Notifications** tab.
2. Select the notification:
   a) In the Notifications By Category section, click the row or right arrow (>) of the category that you want to view.
   b) In the list of notifications for the category, click the row or right arrow (>) next to the notification that you want to edit.
3. To enable or disable an email digest for the notification, if an email digest is available:
   a) Click the **Email Digest** switch.
      The email digest is enabled when the switch is green and disabled when the switch is grey.
   b) If you enabled the digest, select the **Interval** (length of time) during which the notifications are accumulated.

   ![Image]

   The digest interval begins with the first occurrence of notification activity. For example, if you select the daily (1 Day) interval and the first notification occurs at 07:00, the system begins accumulating notifications at 07:00 and stops at 07:00 the next day.

   Soon after the interval ends, the system sends the email digest to you instead of sending the individual notifications generated during the digest interval. If you disabled the digest, the system immediately stops accumulating the notifications for the digest and does not send the email digest. The system resumes sending the notifications as they are generated.
Automating system responses to inbound email

Save time from responding to emails manually when you configure your instance to send replies, create incidents, or update records automatically in response to inbound emails.

You can define system responses to inbound emails in two ways:

- Create an inbound email flow in Flow Designer
- Script an inbound email action

Inbound email trigger in Flow Designer

With the inbound email trigger in Flow Designer, you can create flows that define the automated processes that your instance takes when it receives an email.

Inbound email flows take priority over inbound email actions. If you create flows with inbound email triggers, emails are first processed by the inbound email triggers before they are processed by inbound email actions.

The following diagram shows the processing order for inbound emails. When an email is sent to your instance, the system first classifies the email as a reply, forward, or new email. Then the system runs the inbound email through an inbound email flow. If the flow issues stop processing, the email is finished being processed. If the flow does not issue stop processing, the system tries to match the email to another inbound email flow. If at any point the email does not match with an inbound email flow, the system matches the email to an inbound email action instead.
The benefits to automating system responses to inbound emails in Flow Designer are:

- Provides an easy and accessible interface that uses natural language.
- Consolidates configuration and runtime information into a single environment so process owners and developers can create, operate, and troubleshoot flows from a single interface.
- Reduces upgrade costs, with upgrade-safe Now Platform logic replacing complex custom script.
- Reduces development costs by providing a library of reusable actions.

For more information on creating inbound email flows in Flow Designer, see Flow trigger types or follow the steps in Create a flow with an inbound email trigger. To view or manage your inbound email flows, navigate to Flow Designer > Inbound Email Flows.
Inbound email actions

Define an inbound email action to script how the system responds to an inbound email.

**Note:** Inbound email flows take priority over inbound email actions. If you create flows with inbound email triggers, emails are first processed by the inbound email triggers before they are processed by inbound email actions.

Inbound email actions are similar to business rules: both use conditions and scripts that take action on a target table. An inbound email action checks the email for a watermark that associates it with a task and checks for other conditions. If the conditions are met, the system takes the inbound email action that you configure. The system can take two types of actions:

- Record action: setting a value for a field in the target table.
- Email reply: sending an email back to the source that triggered the action.

By default, if an email has no identifiable watermark, an inbound email action attempts to create an incident from the message. If the email has a watermark of an existing incident, an inbound email action updates the existing incident according to the action’s script.

Watch this six-minute video to learn about the actions that the instance can take in response to messages from users and shows how to create or modify email notifications to users.

Inbound email receive types

The system classifies all incoming email into one of three types: forward, reply, or new.

**Inbound action classifications**

<table>
<thead>
<tr>
<th>Order</th>
<th>Type</th>
<th>Criteria</th>
</tr>
</thead>
</table>
| 1     | Forward | The system classifies an email as a forward only when it meets all these criteria:  
- The **subject line** contains a recognized forward prefix such as **FW**:  
- The **email body** contains a recognized forward string such as **From**.  
The system classifies any email that meets these criteria as a forward, even if the message contains a watermark or record number that otherwise classifies it as a reply. |
| 2     | Reply  | The system classifies an email as a reply when it fails to match it to the forward receive type and it meets any one of these criteria:  
- The subject line or email body contains a recognized **watermark** such as **Ref:MSG0000008**.  
- There is no watermark and the **Reply-To header** contains a recognized message ID of an email with a target record.  
- There is no watermark and the subject line contains a recognized reply prefix such as **RE**; and a recognized record number such as **INC0005574** |
<table>
<thead>
<tr>
<th>Order</th>
<th>Type</th>
<th>Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>New</td>
<td>The system classifies an email as new when it fails to match it to the forward and reply receive types.</td>
</tr>
</tbody>
</table>

**Determining the type of incoming email**

**Attachments**

If an inbound email contains one or more email attachments, the inbound email action adds the attachments to the first record the action produces.
Character encoding

- If the email encoding is ASCII-7 or UTF-8, inbound email actions preserve the character encoding in any associated task records they produce.
- If the email encoding is ISO-8859-1, the inbound email action attempts to convert the email to Windows 1252.
- Inbound email actions convert any other encodings (for example, Mac OS Roman) to plain text, which may or may not be readable.

See the System email log and mailboxes for examples of what you might see if a notification or inbound email action is not processed.

Note: The state of all incoming emails that have been run against inbound email actions, even if there is no matching action, is changed to Processed.

Domain separation

The system ignores the domain that the inbound email action record is in when it creates a record based on the inbound email action. Keep inbound actions in the global domain. For example, if your inbound email action creates an incident, the system creates the incident in the same domain as the user in the Caller field. If that user is not in the User [sys_user] table, the incident is in the global domain.

Inbound email action processing

The system determines which inbound actions to run by comparing the inbound email type and inbound action conditions to the incoming email message. Certain properties are available to set the reply and forwarding prefixes in the email subject lines that your instance recognizes when processing inbound emails.

Note: Inbound email flows take priority over inbound email actions. If you create flows with inbound email triggers, emails are first processed by the inbound email triggers before they are processed by inbound email actions.

The system follows this processing flow to determine whether to run an inbound action.
The system only runs an inbound action when:

- The incoming email type matches the inbound action **Type**.
- If present, the watermark or record number refers to a record in the **Target table**.
- The inbound action **Conditions** evaluates to true.

If any of these criteria are not met, the system skips the current inbound action and evaluates the next active inbound action. The system processes inbound actions from the lowest to highest **Order** value. If the inbound action has **Stop processing** enabled, the system updates the **State** of the email record to **Processed** after running the inbound action **Script**.

The following video shows how an inbound action condition prevents an incident from being created.
Prefixes recognized in email subject lines

Email reply prefixes

When no watermark is present or the In-Reply-To email header is present, the instance recognizes email containing a prefix from the glide.email.reply_subject_prefix property as reply email. You can use this property to set non-standard reply prefixes in your email system.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.reply_subject_prefix</td>
<td>Specifies the list of prefixes (comma-separated) in the subject line that identify an email reply.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: re:,aw:,r:</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to the System Properties [sys_properties] table</td>
</tr>
</tbody>
</table>

Note: Prefixes are case insensitive.

Email forward prefixes

Emails with certain prefixes trigger the forward type of inbound email action. The instance recognizes any email whose subject line contains a prefix from the glide.email.forward_subject_prefix property as forwarded email. Emails with these prefixes trigger inbound email actions of the type forward. Use this property to set non-standard forward prefixes in your email system or you want email forwards to behave like replies. If the value of the system property is empty, then the system reverts to using the values fw: and fwd:.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.forward_subject_prefix</td>
<td>Specifies the list of prefixes (comma-separated) in the subject line that identify a forwarded email.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: fw:,fwd:</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to the System Properties [sys_properties] table</td>
</tr>
</tbody>
</table>

Note: Prefixes are case insensitive.

Email forwards as replies

Properties are available to force inbound actions to process forwarded mail as replied mail. These properties control the subject prefix that the inbound actions use.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.reply_subject_prefix</td>
<td>re:,Re:,RE:,aw:,r:,fw:,fwd:,Fwd:,FWD:</td>
</tr>
<tr>
<td>glide.email.forward_subject_prefix</td>
<td>[any text that is not a forward prefix]</td>
</tr>
</tbody>
</table>
These properties cause the Update Incident inbound action to process all forwarded and replied-to mail.

**Note:** The `glide.email.forward_subject_prefix` property must contain some text so that the forwarded email can be processed as a Reply. It can be any text except a forward prefix (that is, `fw:`., `fwd:`., `Fwd:`., `FWD:`).

### Matching a sender email address to a user

The instance matches a sender’s email address to an active user in the User [sys_user] table using inbound actions.

**Note:** The Email Automatic User Creation plugin must be active.

When processing an email, the instance sets the current user to the user whose email address matches `email.from`. Inbound actions can then reference that current user. For example, the base system inbound action Create Incident sets the `caller_id` of the incident to the value returned by `gs.getUserID()`.

If multiple users have the same email address, the instance first searches for an active user with the email address. The instance does not match inactive users.

**Note:** Each user record must have a unique email address so that the instance can reliably match the email to the correct user.

If a unique email address for each user is not possible, assign a shared email address to only one active user so that the instance always matches incoming email from that address to the active user.

### Matching watermarks in the Subject line or Body

The following examples illustrate how the instance matches randomized watermarks in an email subject line or body.

**Note:** For instances upgraded from a release before Jakarta, the system can recognize both randomized and non-randomized watermarks during a watermark transition period.

#### Examples of matching watermarks in the Subject line or body

<table>
<thead>
<tr>
<th>Subject Line or Body Contents</th>
<th>Matching Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ref:MSG0000008_aLJc130zDhCVuh3spXmt</td>
<td>The instance recognizes this string as a watermark and searches the Email Watermarks [sys_watermark] table for a record with the number MSG0000008_aLJc130zDhCVuh3spXmt. If this watermark exists, the instance matches the email to the associated record. If this watermark does not exist, the system processes inbound email messages as described in Criteria for matching email to inbound actions.</td>
</tr>
</tbody>
</table>
Subject Line or Body Contents | Matching Results
--- | ---
Ref:MSGWTR0000008_wfLLz42lxCgUvG2jIYnh | The instance recognizes this string as a watermark and searches the Email Watermarks [sys_watermark] table for a record with the number MSGWTR0000008_wfLLz42lxCgUvG2jIYnh. If this watermark exists, the instance matches the email to the associated record. If this watermark does not exist, the system processes inbound email messages as described in Criteria for matching email to inbound actions.

Matching record numbers in the Subject line or Body

The following examples illustrate how the instance matches record numbers in the subject line of an email to an existing record when no watermark is present.

Examples of matching record numbers in the Subject line

<table>
<thead>
<tr>
<th>Subject line contents</th>
<th>Matching results</th>
</tr>
</thead>
<tbody>
<tr>
<td>RE: Example INC0005574</td>
<td>The instance recognizes this subject line as a reply and recognizes the INC prefix as belonging to the Incident table. The instance searches the Incident table for an existing record INC0005574. If this incident exists, the email is associated with this incident. If this incident record does not exist, the instance uses the inbound action for new emails to create an incident and associates the new incident with the email.</td>
</tr>
<tr>
<td>RE: Example &quot;INC0005574&quot;</td>
<td>The instance recognizes this subject line as a reply but does not recognize the &quot;INC prefix as belonging to the Incident table because of the quotation mark. The same error occurs for any character other than a space before the record number. The instance instead uses the inbound action for new emails to create an incident and associates the new incident with the email.</td>
</tr>
<tr>
<td>RE: Example INC0005574*</td>
<td>The instance recognizes this subject line as a reply and recognizes the INC prefix as belonging to the Incident table. The instance searches the Incident table for an existing record INC0005574*, which it cannot find because of the quotation mark. The same error occurs for any character other than a space at the end of the record number. The instance instead uses the inbound action for new emails to create an incident and associates the new incident with the email.</td>
</tr>
</tbody>
</table>
Subject line contents | Matching results
--- | ---
RE: CHG0008593 and INC000576 | The instance recognizes this subject line as a reply and recognizes one, but not both, of the number prefixes. There is no way to predict which prefix the instance matches first. Whichever prefix it matches, it searches the corresponding table for a matching record. If the record exists, the email is associated with the table. If the record does not exist, the instance uses the inbound action for new emails to create an incident and associates the new incident with the email.

**Note:** The instance does not support processing email with multiple numbers in the subject line because there is no way to predict which record the instance matches first. For this reason, do not include more than one $number variable in your notifications.

FW: Example INC0005574 | The instance recognizes this subject line as a forward because of the FW: prefix. It uses the inbound action for forwarded emails to create an incident and associates the new incident with the email.

Example INC0005574 | The instance recognizes this subject as a new email because it does not contain a matching reply or forward prefix. It uses the inbound action for new emails to create an incident and associates the new incident with the email.

---

**Criteria for matching email to inbound actions**

The system matches incoming email to the conditions of the active inbound actions. The default inbound actions create or update task record under these conditions.
**Default matching criteria**

If you customize or deactivate the default inbound actions, the system checks the conditions of the active inbound actions. If the system cannot find an inbound action with matching conditions, it sets the state to **Processed**.
Custom matching criteria

Inbound action type criteria

<table>
<thead>
<tr>
<th>Inbound email action type</th>
<th>Required matching criteria</th>
<th>Name of default action (Incident table)</th>
<th>Result of default action</th>
</tr>
</thead>
</table>
| Forward                   | The email contains the following conditions:  
1. A subject starting with a recognized forward prefix (even if a watermark or an In-Reply-To header is present).  
2. From <user email> appears anywhere in the email body. | Create Incident (Forwarded) | Create new record |
<table>
<thead>
<tr>
<th>Inbound email action type</th>
<th>Required matching criteria</th>
<th>Name of default action (Incident table)</th>
<th>Result of default action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reply</td>
<td>The email contains one of the following conditions and the table specified in the email matches the table of the inbound action: 1. A valid watermark that matches an existing record. 2. An In-Reply-To email header (when no watermark is present) that matches an existing record. 3. A subject line starting with a recognized reply prefix (when neither a watermark nor an In-Reply-To header is present) and a valid record number that matches an existing record.</td>
<td>Update Incident (BP)</td>
<td>Update existing record</td>
</tr>
<tr>
<td>New</td>
<td>The email does not meet the conditions for either a reply or forward type inbound email action</td>
<td>Create Incident</td>
<td>Create new record</td>
</tr>
</tbody>
</table>

If more than one inbound action is available for a particular type, the instance uses the Table field to match the email to a particular table. If there is also more than one action for the inbound action's table, the instance uses the Order field to determine the order in which the actions run.

Create an inbound email action

You can create inbound email actions to define the actions that the system takes when an email is received.

Role required: admin

1. Navigate to System Policy > Email > Inbound Actions.
2. Click New.
3. Fill in the fields as described in the table.
**Note:** You might need to configure the form to see all fields.

### Inbound Email Actions form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When to run</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Enter a descriptive name for this email action.</td>
</tr>
<tr>
<td>Target table</td>
<td>Select the table where the action adds or updates records.</td>
</tr>
<tr>
<td>Action type</td>
<td>Select the type of action the instance takes. Select <strong>Record Action</strong> to modify a record in the instance, or select <strong>Reply Email</strong> to have the instance send an email back to the source of the inbound email.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to activate the inbound email action. Clear the check box to disable the action.</td>
</tr>
<tr>
<td>Stop processing</td>
<td>Select this check box to prevent the system from running additional inbound email actions after this action runs.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the message type required to run the action. The action runs only if the inbound email is of the selected type. Available types are: &lt;ul&gt;&lt;li&gt;<strong>New:</strong> An email that is not recognized as a reply or forward.&lt;/li&gt;&lt;li&gt;<strong>Reply:</strong> An email with a watermark with an In-Reply-To email header, or whose subject line begins with a recognized reply prefix.&lt;/li&gt;&lt;li&gt;<strong>Forward:</strong> An email whose subject line begins with a recognized forward prefix, even if the email also contains a watermark or In-Reply-To header.&lt;/li&gt;&lt;/ul&gt;</td>
</tr>
<tr>
<td>Required roles</td>
<td>Specify required roles the sender must have to trigger the inbound action.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number that specifies when this inbound action runs relative to other inbound actions that use the same target table. The instance processes the action with the lowest order number first.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>From</td>
<td>Select the user required to run the action. If a user is selected, the action runs only when the email sender matches the user name. Leave this field blank to perform the action for all users.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the selected user is later archived or deleted, the restriction is removed and anyone can trigger the inbound email action.</td>
</tr>
<tr>
<td>Condition</td>
<td>Specify the condition that must evaluate to true to trigger the inbound action. Build a condition with the choice lists or enter a statement that determines when the inbound email action runs. For example:</td>
</tr>
</tbody>
</table>
|            | ```
|            |   email.subject. startsWith
|            |     ( "chg:" )
<p>| Actions    |                                                                                                                                                                                                             |
| Field actions | This field appears if the Action type is Record Action. Specify how information in the email is inserted into the record.                                                                                       |
|            | For example, select [Created by] [From email] [Sender], so that when the request is inserted, you can see who it is for.                                                                                         |
| Reply email | This field appears if the Action type is Reply Email. compose the email message to send to the source that triggered the inbound email action.                                                                |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>Enter the script the action runs. Typically, this script uses the validators script include and email variables. A template is provided:</td>
</tr>
<tr>
<td></td>
<td>(function runAction(/ <em>GlideRecord</em>/ current, / <em>GlideRecord</em>/ event, / <em>EmailWrapper</em>/ email, / <em>ScopedEmailLogger</em>/ logger) { // Implement email action here })(current, event, email, logger);</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a detailed explanation of what this inbound email action does.</td>
</tr>
</tbody>
</table>

**Accessing email object variables**

An inbound email action script contains the email object to access various pieces of an inbound email through variables. You can use the global variable sys_email with inbound email actions.
## Accessing email objects with variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>email.to</code></td>
<td>Contains a comma-separated list of email addresses in the To: and Cc: boxes.</td>
</tr>
<tr>
<td><code>email.direct</code></td>
<td>Contains a comma-separated list of email addresses in the To: box.</td>
</tr>
<tr>
<td><code>email.copied</code></td>
<td>Contains a comma-separated list of email addresses in the Cc: box.</td>
</tr>
<tr>
<td><code>email.body_text</code></td>
<td>Contains the body of the email as a plain text string.</td>
</tr>
<tr>
<td><code>email.body_html</code></td>
<td>Contains the body of the email as an HTML string.</td>
</tr>
<tr>
<td><code>email.from</code></td>
<td>Contains an email address that depends on the following conditions:</td>
</tr>
<tr>
<td></td>
<td>• If the address listed in the email <strong>Headers</strong> field matches an existing user’s <strong>Email address</strong>, this variable contains the user’s email address.</td>
</tr>
<tr>
<td></td>
<td>• If the address listed in the email <strong>Headers</strong> field does not match an existing user’s <strong>Email address</strong>, this variable contains the address listed in the email <strong>Headers</strong> field.</td>
</tr>
<tr>
<td><code>email.from.sys_id</code></td>
<td>Contains the Sys ID of the user who sent the email to the instance.</td>
</tr>
<tr>
<td><code>email.origemail</code></td>
<td>Contains the address of the email sender as listed in the email <strong>Headers</strong> field.</td>
</tr>
<tr>
<td><code>email.subject</code></td>
<td>Contains the subject of the email as a plain text string.</td>
</tr>
<tr>
<td><code>email.recipients</code></td>
<td>Contains a comma-separated list of recipient addresses as a plain text string.</td>
</tr>
<tr>
<td><code>email.recipients_array</code></td>
<td>Contains the recipient addresses as an array.</td>
</tr>
<tr>
<td><code>email.content_type</code></td>
<td>Contains the MIME content type of the email (for example, <code>text/plain; charset=&quot;us-ascii&quot;</code> or <code>text/html; charset=&quot;us-ascii&quot;</code>).</td>
</tr>
<tr>
<td><code>email.headers</code></td>
<td>Contains details about the sender, route, and receiver as a plain text string in the format of the sending email client.</td>
</tr>
<tr>
<td><code>email.importance</code></td>
<td>Contains an indication from the sender about how important a message is. The value can be <strong>High</strong>, <strong>Low</strong>, or empty.</td>
</tr>
</tbody>
</table>

**Note:** The instance follows **RFC 2822** (Internet Message Format), which requires multiple email addresses in a group to be separated by commas, not semicolons. The instance can set the values of the `email.to`, `email.direct`, and `email.copied` variables only if emails addressed to groups follow the expected RFC format.
Inbound *email.recipient* variables

The recipients variables (*email.recipients, email.recipients-array*) allow processing of inbound email based on the email recipients. For example, you can create a script to process email based on the array values:

```javascript
var array = email.recipients_array; for (var i = 0; i < array.length; i++) { var recipient = array[i]; // do something with it }
```

The *sys_email* variable

This variable lets you access the received sys_email record that triggered the inbound email action. It can be used to reference fields on the email record, such as *uid, sys_id, content_type*, and so on.

Email user matching

When the instance receives an email message, the system searches for an existing user record with the same email address as the sender.

<table>
<thead>
<tr>
<th>Value of email.from Variable</th>
<th>Matching User ID</th>
<th>Email Address</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td>Michael Tossi</td>
</tr>
<tr>
<td>&quot;Michael Tossi&quot;</td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td>Michael Tossi</td>
</tr>
<tr>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td>Michael Tossi</td>
</tr>
<tr>
<td>&quot;Tossi, Michael&quot;</td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td><a href="mailto:michael.tossi@company.com">michael.tossi@company.com</a></td>
<td>Michael Tossi</td>
</tr>
<tr>
<td><a href="mailto:mtossi@company.com">mtossi@company.com</a></td>
<td><a href="mailto:mtossi@company.com">mtossi@company.com</a></td>
<td><a href="mailto:mtossi@company.com">mtossi@company.com</a></td>
<td>Tossi</td>
</tr>
</tbody>
</table>

Note: This functionality requires that you activate the Email Automatic User Creation plugin.

Inbound Email Action scripts no longer support the *gs.createUser()* method. Use either the automatically-generated email variables or the *gs.GetUserID()* method instead.

User impersonations and inbound actions

When the instance receives an email, it can take a variety of actions by impersonating the sender.

If the sender of an incoming email matches an existing user, the instance impersonates the matching user to complete any inbound email actions. If the sender does not match an existing user, the instance impersonates the Guest user to complete any inbound email actions. If the impersonated user is locked out, the inbound email action fails.

Note: If inbound email comes from an untrusted domain, the instance impersonates the Guest user unless you explicitly prevent users from untrusted domains from triggering inbound actions. For more information on filtering domains, see Designate untrusted and trusted email domains.
Enable automatic user creation

An administrator can set an email property to automatically create users from incoming email. The administrator provides a list of trusted domains to prevent untrusted users from being automatically created.

Role required: admin

For example, you can prevent email from users outside your company domain from creating incidents. When an instance receives a message and there is no matching email address from the sender, the instance can create a user with the User ID [sys_user.user_name] set to the sender's full email address.

Users in your instance must still have write and update access to the records that they create or update through inbound email actions.

Creating users from incoming email

<table>
<thead>
<tr>
<th>Value of email.from Variable</th>
<th>User ID Created</th>
<th>Email Address</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td>New User</td>
</tr>
<tr>
<td>&quot;New User&quot;<a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td>New User</td>
</tr>
<tr>
<td>&quot;User, New&quot;<a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td><a href="mailto:new.user@company.com">new.user@company.com</a></td>
<td>New User</td>
</tr>
<tr>
<td>&quot;User&quot;<a href="mailto:nuser@company.com">nuser@company.com</a></td>
<td><a href="mailto:nuser@company.com">nuser@company.com</a></td>
<td><a href="mailto:nuser@company.com">nuser@company.com</a></td>
<td>User</td>
</tr>
</tbody>
</table>

1. Navigate to System Properties > Email Properties.
2. Select the check box for Automatically create users for incoming email from trusted domains (glide.pop3readerjob.create_caller).

Property name: glide.pop3readerjob.create_caller

Automatically create users for incoming emails from trusted domains

☐ Yes | ☐ No
3. Enter the list of trusted domains in **Trusted domains for creating users from incoming emails** *(glide.user.trusted_domain)*.

   ![Property name: glide.user.trusted_domain]

   Trusted domains when creating new users from incoming email (ignore email from untrusted domains unless from an existing user; use * for all domains)

   `*`

   **Note:** The *glide.user.trusted_domain* property only prevents user creation if the sender is not from a trusted domain. The system processes the inbound actions of the email as a guest user. If you want the system to ignore these email messages, use the email filters plugin, specifically the "ignore sender" setting. You can also prevent untrusted users from triggering inbound actions by locking out the guest user.

4. Click **Save**.

5. Optional: Complete the following steps to lock out the guest user.
   a) Navigate to **User Administration > Users** and select the user **guest**.
   b) Select the **Locked out** field to disable the guest account.

When the property *glide.pop3readerjob.create_caller* is set to **false**, the instance runs inbound actions from users who do not match an existing user by impersonating the guest user.

If the property *glide.pop3readerjob.create_caller* is set to **true**, but a user has a valid email address associated with a non-primary device, the instance creates a new user record for that email address if there is no matching email address in the Users [sys_user] table. The instance does not validate non-primary email addresses against the Notification Devices [cmn_notif_device] table.

The method the instance uses to create users can be upgraded to use the full email address by activating the Email Automatic User Creation plugin.

The plugin sets the property *glide.email.create_userid_from_email* to **true** by default. After activating the plugin, enable automatic user creation from email.

   ![Warning: Review your existing user records to reconcile any that contain identical email addresses. If you activate the plugin prior to reconciling email addresses, your instance cannot distinguish between users with identical email addresses and randomly selects one of the users with the matching email address.]

**Allowing locked out users to process inbound email actions**

A property is available to allow locked out users to trigger inbound actions. For example, enabling the property can allow locked out users to reset their password and send email to the instance asking for assistance.
Property allowing locked out users to trigger inbound email actions

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.pop3.process_locked_out</td>
<td>Enables (true) or disables (false) the ability for locked out users to trigger inbound actions.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• System Properties [sys_properties] table</td>
</tr>
</tbody>
</table>

**Warning:** Enabling this property (glide.pop3.process_locked_out) also enables users from untrusted domains to trigger inbound actions.

Redirecting email to the instance POP3 account

Configure other mailboxes to forward email to the instance’s POP3 account.

By default, the POP Reader scheduled job checks for new email every two minutes. It connects to the mail server and account specified in email properties. The POP Reader downloads any email waiting on the mail server and creates email.read events. After the instance processes the events, the inbound email actions run.

The POP Reader shows the number of emails processed during the reader’s last run. The message shows the number of emails the reader processed or 0 processed if no emails were available. The reader resets the status each time it runs.

While it is not possible to specify more than one POP3 account for the instance, you can forward other mailboxes to the designated POP3 account. This script can be added to the Create Incident inbound email action to differentiate the content based on the original recipient, and then set an assignment_group value.

```java
if(email.direct.indexOf('facilities@anycorp.com')>-1)
current.assignment_group.setDisplayValue('Facilities Management');
```

Setting field values from the email body

Values in an inbound email can set field values in a task record.

Any name:value pair in an inbound email body gets parsed into a variable/value pair in the inbound email script. The name:value pair must be on its own line. Note that most email clients limit the number of characters allowed per line and may truncate excessively long name:value pairs.

**Tip:** To prevent unexpected parsing, ensure that all the names in the name:value pairs are unique.

To populate a reference field, use `setDisplayValue()` instead. See Redirecting Emails for an example of using `setDisplayValue()` in an inbound email action.

**Note:** The action always generates a lowercase variable name. Also, this functionality does not work on reference fields.

For example, if an email body contains this line:

```text
Foo:bar
```
The inbound email script creates the variable `email.body.foo` with the value of `bar`. You can use these variables to create conditions such as:

```javascript
if(email.body.foo!=undefined){
    current.[field]=email.body.foo;
}
```

In this example, the script sets the value of `[field]` to the value `bar`.

**Note:** Spaces are rendered as underscores when a name:value pair gets parsed into a variable/value pair. For example, if an email body contains a line with spaces like `my variable:data`, then the inbound email script creates the variable `email.body.my_variable`. The value of the variable is `data`.

## Integrate inbound events

This example illustrates how to create a notification from an inbound JSON request.

**Role required:** admin

When complete, you will be able to:

- Send a JSON request to the `[imp_notification]` web service import set with the JSON processor
- Create a new import set in the `[imp_notification]` table in the instance using data from the JSON request

The following example steps assume you have your own demonstration instance.

1. Activate the JSON Web Service plugin.
2. Install the RESTClient Firefox plugin.
3. Open the RESTClient.
4. Create the following JSON request.
   - **Method**: POST
   - **URL**: http://<instance name>.service-now.com/imp_notification.do?JSON
   - **Headers**: Authorization: Basic
   - **Body**:
     ```json
     {
       "sysparm_action":"insert","message":"this is an event","uuid":"abc"
     }
     ```

5. Click Send.
7. Verify that the instance sends back a response with a `sys_id`.

8. Login to your development instance.
10. Verify that the import set table has an event matching your JSON request.

Reprocess received emails

When a email has been processed incorrectly, fix the underlying problem, then reprocess the email. You can reprocess emails individually or in a batch.

Role required: admin

Various scenarios can result in improperly processed emails. After taking corrective action, reprocess the emails to get correct email records. Two of the most common scenarios are:

- The inbound action failed to trigger correctly. After you update or fix the inbound action, reprocess the affected emails to create the correct records.
- Emails have accidentally ended up on a development instance, usually due to the username or password of a production or test instance being reused on the development instance. In this case, you first export the emails from the development instance as XML and import them to the correct instance. On the correct instance, reprocess the imported emails to obtain correct email records.

You can reprocess emails with the types `received` or `received-ignored`. Such emails are processed to the system mailboxes `Received` and `Junk`, respectively.

Take the following steps only after fixing the underlying problem. This procedure only reprocesses the emails.

1. Navigate to the relevant `System Mailbox` or navigate to `System Logs > Email`. 
2. Decide whether to reprocess emails individually or in a batch.
   - To reprocess an individual email, open that email and click **Reprocess**
     ![Reprocess button](Image1)
   - To reprocess several emails at once, select them from the mailbox or the email log and apply the **Reprocess received emails** action.

![Email reprocessing interface](Image2)
Remember that you can reprocess only received or received-ignored emails.

Inbound email action examples

Various examples of inbound email actions are available to help you build your own inbound email actions. These examples show how to set up inbound email actions to handle email replies, create (log) a problem record, request a change, and update an incident.

Inbound email action example: handling email replies

This example shows you how to set up inbound email actions to handle replies that users send back to the instance.

Role required: admin

The inbound email action parses the email and responds using a script. By default, an email received by the instance creates a new incident, and the body of the email is added to the Additional Comments text box. More refined Inbound Email Actions can create incident tickets with more data, thus saving the incident management team valuable time.

Normally, when a user responds to an email sent by the instance, the inbound email action matches the watermark to an existing incident, and updates the incident rather than creating a new record. However, if the watermark is missing, this inbound email action attempts to match a reply to the original incident.

This inbound email action is replicated in Flow Designer as the sample flow Inbound Email Flow Example: handling email replies. To view the sample flow, navigate to Flow Designer > Designer.

1. Navigate to System Policy > Inbound Actions and click New.
2. Populate the form as follows:

   Inbound action field values

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Update Incident</td>
</tr>
<tr>
<td>Type</td>
<td>Reply</td>
</tr>
<tr>
<td>Target table</td>
<td>Incident [incident]</td>
</tr>
</tbody>
</table>

3. In Script, enter this code.

   ```javascript
   gs.include('validators');

   //Note: current.caller_id and current.opened_by are already set to the first UserID that matches the From: email address
   if (current.getTableName() == "incident") {
       current.comments = "reply from: " + email.origemail + "\n\n" + email.body_text;

       if (email.body.assign !== undefined)
           current.assigned_to = email.body.assign;

       if (email.body.priority !== undefined && isNumeric(email.body.priority))
           current.priority = email.body.priority;

       if (email.body.category !== undefined)
           current.category = email.body.category;

       if (email.body.short_description !== undefined)
           current.short_description = email.body.short_description;
   }
   ```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Inbound email action example: logging a problem

This example shows you how to set up inbound email actions to create a problem record.

Role required: admin

Inbound email actions allow users to log or update incidents on an instance via email. The inbound email action parses the email and responds using a script.

This inbound email action is replicated in Flow Designer as the sample flow Inbound Email Flow Example: logging a problem. To view the sample flow, navigate to Flow Designer > Designer.

1. Navigate to System Policy > Inbound Actions and click New.
2. Populate the form as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Log Problem</td>
</tr>
<tr>
<td>Type</td>
<td>New</td>
</tr>
<tr>
<td>Active</td>
<td>True</td>
</tr>
<tr>
<td>Target Table</td>
<td>Problem [problem]</td>
</tr>
<tr>
<td>Condition</td>
<td>email.subject.indexOf(&quot;Problem: &quot;) == 0</td>
</tr>
<tr>
<td>Script</td>
<td>current.description = email.body_text;</td>
</tr>
<tr>
<td></td>
<td>current.short_description = email.subject.toString().substring(9);</td>
</tr>
<tr>
<td></td>
<td>current.assignment_group.setDisplayValue(&quot;Development&quot;);</td>
</tr>
<tr>
<td></td>
<td>if (email.body.assign != undefined)</td>
</tr>
<tr>
<td></td>
<td>current.assigned_to = email.body.assign;</td>
</tr>
<tr>
<td></td>
<td>current.insert();</td>
</tr>
</tbody>
</table>

Inbound email action example: requesting a change

This example shows you how to set up inbound email actions to create a change request record.

Role required: admin

Inbound Email Actions allow users to log or update incidents on an instance via email. The inbound email action parses the email and responds using a script.

1. Navigate to System Policy > Inbound Actions and click New.
2. Populate the form as follows:
Values automatically set from incoming email

The default inbound action for the Incident table automatically sets the following field values when it receives an incoming email.

<table>
<thead>
<tr>
<th>Field value set</th>
<th>Value used from incoming email</th>
</tr>
</thead>
<tbody>
<tr>
<td>current.caller_id</td>
<td>User ID of the first user whose email address matches the email.from variable.</td>
</tr>
<tr>
<td>current.opened_by</td>
<td>User ID of the first user whose email address matches the email.from variable.</td>
</tr>
</tbody>
</table>

If multiple users have the same email address, the instance first searches for an active user with the email address. Use unique email addresses for each user record whenever possible. If not, having only one active user with the shared email address guarantees that the instance always matches incoming email from this address to the active user.
Specifying the inbound email processing order

You can configure a processing order for inbound email actions and use the order to manage multiple filters in inbound email actions.

The Ordered Email Processing (com.glide.email_ordered_processing) plugin is enabled by default for new instances. Users with the admin role can activate the plugin for upgraded instances. The plugin adds the Order column to the Rules [sysrule] table, which the instance uses to determine when to process emails. Admins can also add a command to an action script that halts processing after the script runs.

Configure the processing order

Configure the processing order for inbound email actions to force them to run in a prescribed order.

Role required: admin

1. Navigate to System Policy > Email > Inbound Actions.
2. Open an existing inbound action or create one.
3. Complete the form and assign an order number to the Order field to establish when this inbound rule should run in relation to other rules. If you upgraded and activated the plugin, the Order field might be named Execution Order.

Note: Ensure each inbound action has a unique Order value to ensure the system stops processing as expected. If multiple inbound actions have the same Order value, the system might evaluate all of the inbound actions, even if one of them contains the event.state="stop_processing"; script or has the Stop processing option selected.
4. To stop rule processing when an inbound email action runs successfully: add the following line to the bottom of the script:

- Select the **Stop processing** check box.
- Add the following line to the bottom of the **Actions** script:

```javascript
  event.state="stop_processing";
```
Inbound Email Actions
Create Incident

Name
Create Incident

Application
Global

Target table
Incident [Incident]

Active
✓

Action type
Record Action

Stop processing
✓

When to run

<table>
<thead>
<tr>
<th>Type</th>
<th>Actions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Execution Order
100

Conditions

Add Filter Condition
Add "OR" Clause

-- choose field --

-- oper --

-- value --

Condition

Required roles

From

Update
Delete
Manage multiple filters in an inbound email action

Use process ordering and the `stop_processing` command to manage multiple filters in inbound email actions.

Role required: admin

In this example, you can create new problem records when `prb:` appears in the subject line and new change requests when `chg:` appears in the subject line. All other emails are used to create an incident. The actions are set up as follows:

1. Create an action with a condition of `Subject > starts with > chg:` and the `event.state="stop_processing";` command appended to the script.
2. Assign this action an Order value of 100.
3. Create an action with a condition of `Subject > starts with > prb:` and the `event.state="stop_processing";` command appended to the script.
4. Assign this action an Order value of 200.
5. Create an action for incident with no conditions and an Order value of 300.

   It is not necessary to add the `stop_processing` command to the script for the incident action unless you want processing to stop at this rule to avoid continuing to another action.

   If either a change request or a problem is created, the `stop_processing` command stops processing, and no incident record is created. If neither a change request nor a problem is created, the inbound email action for incident creates a record.

Notify

Notify provides support for SMS and voice channels on the ServiceNow platform for communicating internally with team members and externally with customers and contractors. The plug-in also provides APIs and workflow activities to achieve the above. Some customers directly make use of the APIs in their products others via products like Major Incident Management, On-Call and CTI Softphone.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Notify release notes</td>
<td>• Activate Notify</td>
<td>• Notify workflow activities</td>
</tr>
<tr>
<td>• Differences between Legacy Notify and Notify</td>
<td>• Configure Notify with Twilio</td>
<td></td>
</tr>
<tr>
<td>• How Notify processes incoming calls</td>
<td>• Notify Number and Number groups</td>
<td></td>
</tr>
<tr>
<td>• Outbound communication requirements</td>
<td>• Notify Provider Selector</td>
<td></td>
</tr>
<tr>
<td>• Notify Properties</td>
<td>• Notify conference calls</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Integrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Using Notify with tasks</td>
<td>• Developer training</td>
<td>• Notify-Twilio Direct driver</td>
</tr>
<tr>
<td>• Using Notify with Incident Communications Management</td>
<td>• Developer documentation</td>
<td></td>
</tr>
<tr>
<td>• Using Notify with On-Call Scheduling</td>
<td>• Components installed with Notify</td>
<td></td>
</tr>
<tr>
<td>• Notify conference calls</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Use SMS with Notify</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Troubleshoot and get help</th>
<th>Migrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Ask or answer questions in the Developer community</td>
<td>• Migrating from Legacy Notify</td>
</tr>
</tbody>
</table>
Activate Notify

You can activate the Notify (com.snc.notify) plugin if you are an administrator. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

Notify activates these related plugins if they are not already active.

Plugins for Notify

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E164 Compliant Phone Number [com.glide.phone_number]</td>
<td>Provides E-164 compliant phone number support.</td>
</tr>
<tr>
<td>SMS Preferences [com.snc.sms_pref]</td>
<td>Provides ability to set SMS preferences for receiving messages from different providers.</td>
</tr>
</tbody>
</table>

Note: If you are upgrading from an earlier version of Notify, the Notify-Twilio driver remains active.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar. You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Differences between Notify and Legacy Notify

Describes the differences between the Notify and Legacy Notify applications, including architecture, workflows, Twilio support, and task-initiated conference calls.

<table>
<thead>
<tr>
<th>Legacy Notify (com.snc.notifynow)</th>
<th>Notify (com.snc.notify)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is deprecated. Supported only telephony services.</td>
<td>Supports pure conferencing solutions such as Zoom in addition to the Telephony providers like Twilio.</td>
</tr>
<tr>
<td>Manage a single number from a Twilio account per instance.</td>
<td>Provides support for multiple numbers per Twilio account, especially cross-geographical scenarios.</td>
</tr>
</tbody>
</table>
### Migrating from Legacy Notify

When migrating to Notify from the Legacy Notify functionality, several changes are made to the instance.

If the Legacy Notify functionality is already enabled, several automatic changes occur when you activate Notify:

- The Legacy Notify menu is removed from the application navigator.
- Two separators are added to the new Notify menu: **Legacy Notify** and **Legacy Notify Admin**. New modules that replace the Legacy Notify modules are added to these sections.
- The notify_admin role allows access to Notify modules.
- The notifynow_admin role allows access to Legacy Notify modules.
- All workflow activities from the Legacy Notify application are moved to the **Legacy Notify** group.

### Notify-Twilio Direct driver

The Notify-Twilio integration with the Notify-Twilio Direct driver provides APIs and workflow activities for applications to handle various notification features.

The Notify-Twilio Direct driver provides the following notification features:

- Start and manage a conference
- Send and receive SMS messages
- Send and receive calls

Notify automatically creates a TwiML application in the Twilio account and configures the application to use the instance as an endpoint.

Phone numbers associated with the Twilio account are imported to Notify. To manage phone numbers per instance, set up one Twilio account for each instance and configure all relevant phone numbers for the instance under that account.

**Note:** Only one Twilio account (or subaccount) can be configured on a given Notify driver at a time. Both the old and new driver can be used simultaneously because they can be configured with different accounts.

### Activation Information

For new customers, only the Notify-Twilio Direct driver is available by default. For customers upgrading to the latest version, both the Notify-Twilio Direct and Notify-Twilio drivers are available.
The Notify plugin must be active to access Notify.

## Differences between Notify-Twilio and Notify-Twilio Direct

Describes the differences between the Notify-Twilio and Notify-Twilio Direct drivers, including architecture, workflows, Twilio support, and task-initiated conference calls.

### Differences between Notify-Twilio and Notify-Twilio Direct

<table>
<thead>
<tr>
<th>Notify-Twilio (com.snc.notify.twilio)</th>
<th>Notify-Twilio Direct (com.snc.notify.twilio_direct)</th>
</tr>
</thead>
<tbody>
<tr>
<td>This plugin is deprecated. Notify - Twilio Direct Driver now replaces this plugin.</td>
<td>Provides next generation integration with Twilio and Notify.</td>
</tr>
<tr>
<td>Uses Java SDK based integration with Twilio.</td>
<td>It is a JavaScript based driver which uses platform provided outbound REST APIs to connect to Twilio.</td>
</tr>
<tr>
<td>NA</td>
<td>Adds support for various advanced SMS features such as Co-pilot messaging, Twilio Notify bulk SMS.</td>
</tr>
<tr>
<td>NA</td>
<td>Adds support for various functionalities in conference calls such as view the participant who is speaking on the conference call, disable beep when someone enters/exits a conference, advanced call features like machine detection and so on.</td>
</tr>
</tbody>
</table>

### Migrate to Notify-Twilio Direct driver

Migrating to Notify-Twilio Direct driver provides next-generation integration with Twilio and Notify.

Role required: notify_admin

You must be connected to Twilio using the Notify Twilio Driver.

1. Click **Migrate Now**.
2. Click **Ok** on the confirmation dialog.
   
   A disconnection of the Twilio driver is initiated and the Account SID and Auth Token are copied to Twilio Direct's configuration page. Twilio Direct is then autoconnected to that account, and you are redirected to the driver's configuration page.

### Configure Notify with Twilio

Configure Notify to use the Twilio telephony service.

You must have an SID and authentication token for an active Twilio account (https://www.twilio.com/). You must have a separate contract with Twilio.

**Important:** Ensure that each instance on which you configure Notify uses a different Twilio account. Each account specifies a unique account SID, authentication token, telephone numbers, and endpoint. Using the same account across multiple instances may cause your Twilio service configuration to be overwritten.

**Note:** Account and sub-account are Twilio categorizations, and both act the same for a ServiceNow instance.

Role required: notify_admin

1. Navigate to **Notify > Administration > Twilio Direct Configuration**.
2. On the Twilio Account Properties page, enter your **Account SID**.

3. Enter your **Auth Token**.

4. Click **Connect**.

   If the account is not associated with an instance and the connection is successful, a read-only list of E.164 and short code phone numbers associated with this Twilio account appears. This list displays the phone number, supported capabilities such as voice or SMS, the country for each Twilio number, and the Notify number group to which the number belongs.

   If the account is already associated with an instance, the system displays an error message. To connect to this account,
   - Disconnect the account from the instance.
   - Delete the TwiML apps in the Twilio account.

   **Note:** If you buy or release numbers on the Twilio account, open the configuration page again to refresh the list of numbers. Numbers removed from the Twilio service remain as Notify Number records, but with the **Active** field set to false. Use only active phone numbers for inbound or outbound communication.

Phone numbers and short codes are provided by Twilio once the account is successfully connected and are stored on the Notify Phone Numbers [notify_number] table. Assign each number to a number group. Number groups allow you to control which workflows run when using the phone numbers in each number group.

**Twilio-Direct callback testing**

Make an outgoing call or send an SMS using Twilio and trigger callbacks to ServiceNow, to test whether Twilio can reach the instance. You can also view when the last callback test was run, its status, and the test logs.

Role required: admin, notify_admin

1. Navigate to **Notify > Administration > Twilio Direct Configuration**.
2. Click **Test Callbacks**.
3. Select the SMS option and click **Initiate SMS**.
4. Select the call option and click **Initiate Test Call**.

   **Note:** The callbacks can be tested only after a connection is established with Twilio.

**Advanced configuration for SMS**

Use the Twilio copilot features to improve SMS delivery with phone number like using multiple numbers to send high-volume messages and content intelligence to automatically format every message without writing custom code. Reach large lists of users with one API request.

Role required: notify_admin

The Twilio co-pilot features are enabled in your instance once configured. An example of a copilot feature is that you can configure which identity (phone number, shortcode, or alpha sender ID) to use to send a message. You can also spread the messaging traffic over several phone numbers or prioritize an alpha sender ID when sending messages to countries where alpha senders are commonly used. To know more about these features, visit [https://www.twilio.com/copilot](https://www.twilio.com/copilot).

**Important:** All the Twilio numbers must be part of the same messaging service for which you have enabled the **Advance SMS Features** feature.
The Twilio Notify bulk SMS feature is used to send SMS in bulk to customers. Use the passthrough sendBulkSMS API to reach large number of users across using a single API request. For more information on these features visit https://www.twilio.com/notify

1. Navigate to Notify > Administration > Twilio Direct Configuration.
2. On the Twilio Account Properties page, enter your Account SID.
3. Enter your Auth Token.
4. Click Connect.
5. On the Advance SMS Features tab, check the Intelligent SMS Handling box.
   To setup Alpha Sender ID, users need to go to Twilio console.
6. On the Advance SMS Features tab, check the Twilio Notify Bulk SMS box.

   **Note:** This feature uses Twilio Notify feature and might have an associated cost. Contact Twilio Support for more details.

### Advanced configuration for voice

Configure Answering Machine Detection (AMD) to determine if a human has picked up the call or not.

Role required: notify_admin

1. Navigate to Notify > Administration > Twilio Direct Configuration.
2. On the Twilio Account Properties page, enter your Account SID.
3. Enter your Auth Token.
4. Click Connect.
5. On the Advance Voice Features tab, check the Detect answering machine box.
6. On the Advance Voice Features tab, enter the number of seconds in the Machine detection timeout field to set a timeout value.

### Disconnect from a Twilio account

If a Twilio account is already associated with a different system, disconnect the account from the other system before connecting to the current instance.

Role required: notify_admin

1. Navigate to Notify > Administration > Twilio Direct Configuration.
2. On the Twilio Account Properties page, click Disconnect.
3. In the Disconnecting Twilio account pop-up window, click OK.

   The account is disconnected from the instance. The system clears the Account SID and Auth Token fields and deactivates the list of associated phone numbers.

### Public URLs

On-premise customers should ensure that the URLs are accessible from the Internet for the Notify-Twilio driver to work correctly.

The Notify-Twilio drivers (both new and old) require that specific URLs on the instance be accessible from the Internet by the Twilio server without authentication. If the instance is within a private network, you need to either port forward or set up a reverse proxy.

For the Notify-Twilio driver, the URLs are:

- /NotifyTwilioCallProcessor.do
ServiceNow DocVersion Now Platform capabilities

- /NotifyTwilioCallStatusProcessor.do
- /NotifyTwilioSMSProcessor.do
- /NotifyTwilioDialStatusProcessor.do
- /NotifyTwilioEventProcessor.do
- /NotifyTwilioDialProcessor.do
- /NotifyTwilioRecordingProcessor.do

For the Notify-Twilio Direct driver, the URLs are:
- /api/sn_twilio_direct/twilio_callbacks/process/twiml/{callback_name}
- /api/sn_twilio_direct/twilio_callbacks/process/xml/{callback_name}

Note: The glide.notify.endpoint property needs to be set to an Internet visible name because the instance name inside a private network can be different from the Internet domain.

Components installed with Twilio Direct driver

Several types of components are installed with the Twilio Direct driver for integration with Notify.

Tables installed with Twilio Direct driver

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_twilio_direct_callback_processor]</td>
<td>Extends the application file. Contains scripts which process callback payloads from Twilio and generate appropriate response XML or TwiML document.</td>
</tr>
<tr>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Extends the application file. Contains configuration option values for the driver.</td>
</tr>
<tr>
<td>[sn_twilio_direct_basic_auth]</td>
<td>Extends the basic auth credentials. The Account SID and Auth token are stored in this table.</td>
</tr>
<tr>
<td>[sn_twilio_direct_callback_test]</td>
<td>Stores the history of callback test runs.</td>
</tr>
</tbody>
</table>

Note: Use caution when editing, deleting or adding new Callback Processor scripts as they are one of the key core components of the driver.

Business rules installed with Twilio Direct driver

Twilio installs the following business rules:

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Connected Disconnected Message</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Verifies if Twilio is completely configured and displays an info message.</td>
</tr>
<tr>
<td>Calculate test duration</td>
<td>[sn_twilio_direct_callback_test]</td>
<td>Sets the duration for Twilio Callback tests.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Machine detection timeout range check</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Verifies the timeout values for detecting the answering machine if the Detect answering machine is enabled. The valid range of the timeout is 3-120 seconds.</td>
</tr>
<tr>
<td>Move credentials</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Moves the account credentials to [sn_twilio_direct_basic_auth]</td>
</tr>
<tr>
<td>Populate Credentials</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Populates the current SID and Auth token from the [sn_twilio_direct_basic_auth] table to display them.</td>
</tr>
<tr>
<td>Set outbound calculated fields &amp; auth</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Sets the account credentials in the basic auth profile</td>
</tr>
<tr>
<td>Set Reset JWT Key</td>
<td>[sn_twilio_direct_basic_auth]</td>
<td>Copies the auth token from [sn_twilio_direct_basic_auth] to signing key password in [jwt_keystore_aliases].</td>
</tr>
<tr>
<td>Validate &amp; set inbound calculated fields</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>Populates the callback_endpoint field based on the inbound rest field value. Displays an error message if the endpoint URLs are not in the correct format.</td>
</tr>
<tr>
<td>Validate Fast Bulk SMS option</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>When Twilio Notify bulk SMS is enabled, validates the Twilio messaging and Notify service id.</td>
</tr>
<tr>
<td>Validate Intelligent SMS option</td>
<td>[sn_twilio_direct_twilio_config]</td>
<td>When Intelligent SMS handling is enabled, validates the Twilio messaging service id.</td>
</tr>
</tbody>
</table>

**Notify Zoom connector**

The Notify Zoom Connector expands the Notify communication channel by managing and initiating a Zoom meeting directly from any task record such as an incident or a change.

**Compatibility**

New York and later

**Key Features**

- Start and end Zoom meeting directly from any task record such as incident, change request or even from Major Incident Workbench.
- Manage Zoom meeting by adding or removing participants.
- Track and report the meeting details, meeting duration, and attendees for further analysis.
System Requirements

- Install and activate the Notify plugin (com.snc.notify) before you install the application.
- Ensure that the system has Zoom Spoke for ServiceNow IntegrationHub plugin (sn_zoom_spoke) installed and the necessary IntegrationHub license to use Zoom for meeting management.

Plugins

ServiceNow IntegrationHub Installer (com.glide.hub.integrations): Suite of plugins necessary to design integration flows in the Flow Designer application.

Set up Notify Zoom connector in Zoom

Use the Notify Zoom connector to expand the Notify communication channel by managing and initiating a Zoom meeting directly from any task record such as an incident or a change.

Role required: admin, Zoom admin

1. Ensure that you have Zoom spoke installed on your instance.
2. Make sure you have the required credentials and connections to Zoom on your instance.
3. Configure the Notify Zoom connector with the same Zoom account with which you created the OAuth app. Also ensure that the same OAuth app is used.

1. On your Zoom OAuth app, navigate to Feature > Add Feature > Event Subscription.
2. Use the toggle button to enable the event subscription feature.
3. In the form that appears, fill in the URL. The URL is specific to your instance and is used to post the information about the events on your instance to Zoom. The format of the URL is: https://yourinstancename.com/api/sn_notify_zoom/notify_zoom/ZoomEvent.
4. Use the Add Events button to list all the events which the URL is informing Notify about.
5. In the categories that appear, select Meeting and select all the meeting-related events from the list and click Done.
6. Under Recording, select All Recordings have completed and Recording Transcript files have completed from the list and click Done.
7. Click Save on the Add feature screen.
8. A Verification Token appears on the Add Feature screen. Record the token by clicking Copy.

Configure Notify with the verification token from Zoom.

Configure Notify Zoom connector in Notify

Configure Notify to receive the event information from Zoom. An event is usually any action that is related to a meeting, like participant added, host left and so on.

Role required: admin

1. Navigate to Notify > Zoom > Configuration.
2. Paste the verification token that you recorded on Zoom Event Subscription screen in the Webhook validation token field.
3. Save the record.

Configure and use Zoom as a conference provider from any of the task records.
Note: The person creating a conference is the host of the conference and must have their email set in their ServiceNow profile and use the same email for the Zoom account.

Disable Zoom meeting password

Disable Zoom meeting password so that you can join a Zoom meeting without any meeting password.
Role required: notify_admin or admin

Note: The feature is compatible with ServiceNow version, New York with Patch 1 and later.

1. Navigate to Notify > Zoom > Configuration.
2. Select Do not set password.
3. Click Update.

Notify voice and SMS capabilities

Notify provides support for SMS and voice channels for communicating internally with team members and externally with customers and contractors.

Notify provides a way for applications to start and manage a conference, send/receive SMS, send/receive calls and present them with IVR like system.

How Notify processes incoming calls

Notify processes incoming calls using workflow activities.

Any Notify activity that manages incoming phone calls creates a record on the Notify Workflow Activity [notify_wf_activity] table. Each notify_wf_activity record is associated with a single call. These records store JSON data detailing the actions to send to the telephony provider.

Notify processes incoming calls in the following way:

1. A person calls a Notify phone number.
2. Notify launches the incoming call workflow associated with that Notify phone number.
3. The workflow reaches a Notify activity and invokes the activity onExecute() function.
4. The activity creates a new notify_wf_activity record detailing any actions to take, with a State value of execute.
5. Notify sends the specified actions to the telephony provider.
6. The notify_wf_activity record State changes to processed.
7. The telephony provider sends a response.
8. Response arguments, such as user input or recording info, are stored as JSON data in the notify_wf_activity response_args field.
9. The notify_wf_activity State changes to complete.
10. The JSON data from the notify_wf_activity record is copied to the Last action field in the Notify call record that triggered the workflow.
11. The workflow invokes the onUpdate() function in executing activities.
12. The activity confirms that the associated notify_wf_activity record has completed, and changes the activity state to finished.
13. The workflow transitions to the next activity.

**Notify conference calls**

Notify administrators, major incident managers, or communications managers can manage conference calls. Conference call records are stored on the Notify Conference Calls [notify_conference_call] table. Conference call participant records are stored on the Notify Conference Call Participants [notify_participant] table.

Conference call and participant records are created automatically when starting and connecting to a conference call. Most fields, such as the **Duration** of a call, are set automatically using business rules.

```
Note: If a participant attempts to join a conference call using an invalid phone number, the caller is added to the participant list and the phone number is marked with a status of **Invalid**.
```

Notify administrators, major incident managers, or communications managers can manage conference call participants.

Several conference call workflows are available by default. These workflows can be used for incoming and outgoing calls and incoming SMS messages. Conference call workflows are:

- Notify: (Re)join Conference Call
- Notify: Join Conference Call Via SMS
- Notify: (Re)join Conference Call with muting

```
Note: Notify: (Re)join Conference Call with muting is available only with demo data.
```

The number groups Conference Call Group and Notify On Task Group use these conference call workflows by default.

**Start a conference call**

Start a conference call from a task or an incident communication plan by inviting one or more users to join a call. The conference will not start until at least two participants join.

Call participants can include:

- Users who have been assigned specific responsibilities
- Ad-hoc user contacts
- Other involved parties who are not recorded as users, such as third-party contacts

1. Navigate to **Incident Communications Management > Open**.
2. Open the relevant incident communication plan.
3. Click the **Initiate Conference Call** related link.
4. From the dialog box that appears, choose the **Conference Bridge** that you want to dial from.
5. Select the participants for the conference.
Initiate conference call

Conference Bridge

+14046204596

Add Participants

Email

User
Group
Phone
Email

Selected

System Administrator (Open)
Lucy Barnes (Incident Manager)

Lucy Barnes (Incident Manager)

Users displayed in red do not have a mobile phone number

Include a brief message for participants

160 characters remaining of 160 characters

Cancel  Start Call
The dialog box displays the Recommended and Selected participants for the conference. All users from the User Contacts list in the incident communication plan are in the Recommended section by default. The user who initiates the conference call is added to the selected list of participants.

If a shift exists for the group contacts, the primary and secondary on-call resources are shown in the Recommended list.

Calls are placed to the number in the Mobile phone field on the user record. If that information is blank, the user cannot be contacted through Notify. The mobile phone number has to be an E.164 compliant phone number. If the phone number is a local number, without the + prefix, the number will be retrieved based on the user's location and, if possible, converted into a valid E.164 number.

6. To select ad-hoc participants,

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the reference lookup icon, and select the relevant user.</td>
<td>Click Add to selected.</td>
</tr>
<tr>
<td>Enter the participant’s phone number</td>
<td>Click Add to selected.</td>
</tr>
</tbody>
</table>

7. After the participant list is finalized, click Start Call.

The conference call starts and a Conference call initiated message is displayed at the top of the incident communication plan form. Each user is called and can accept the call to join the conference.

8. Click the Conference call initiated message to see details of that conference call. When the final participant leaves the conference, the conference call closes.

**Note:** VoIP phone systems, which do not use touch tone phones, may encounter issues with recognizing key presses. To avoid problems, ensure that conference call users use touch tone phones, or configure your VoIP system settings to recognize key presses, as described in your VoIP system documentation.

**Add participants to a conference call**

Add a participant to a conference call using Notify.

Role required: notify_admin, major_incident_manager, or communication_manager

You can add the following participants:

- Users who have been assigned specific responsibilities
- Required ad hoc user contacts
- Other involved parties who are not recorded as users, such as third-party contacts

1. Navigate to Notify > Conference Calls.
2. Open the conference call that you want to add a participant to.
3. Click the Add Participant related link.
4. In the dialog box that appears, select the participants you want to add to the conference. You can add a single participant, a group of participants, or a phone number.
Add Participants dialog box

5. You can send an optional message for the participant who you want to add in the **Include a brief message for participants** field.
6. Click **Add Participant**.
   The selected user, group, or phone number is added to the selected conference call.

**Mute or unmute all participants**

As a communications manager or a conference call host, mute/unmute all the conference participants from the workbench.

Role required: notify_admin, major_incident_manager, or communications_manager

Before starting this procedure, ensure there is an active conference call with one or more participants.

1. Navigate to **Major Incident Management** in the application filters.
2. Select the incident that you are trying to resolve.
3. On the incident, click **View Workbench**
4. In the **Conferences** tab, select a conference

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute All</td>
<td>Click this button to mute all the participants in the conference</td>
</tr>
</tbody>
</table>
### ServiceNow Document Version

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unmute All</strong></td>
<td>Click this button to unmute all the participants in the conference</td>
</tr>
</tbody>
</table>

### Mute All

![Mute All button](image)

**Unmute All**
Mute or kick a conference call participant

As a communications manager, you can mute or kick conference call participants.

Role required: notify_admin, major_incident_manager, or communication_manager

Before starting this procedure, ensure there is an active conference call with one or more participants.

Note: Any participant with the host flag set to active, can mute or kick a participant from a conference call.

1. Navigate to Notify > Conference Calls.
2. Select a conference call.
3. In the Notify Conference Call Participants related list, select a participant.
4. Click Mute or Kick.

Note: You can unmute a muted participant. A kicked participant may rejoin the conference call by calling in again.

Send a message to conference call participants

Send a brief message as a text or voice message to the participants of a conference call to set a context to the call.

Role required: major incident manager

You must configure a telephony provider like Twilio so that you can use one of the Notify numbers to send SMS to the conference call participants.

1. Navigate to Major Incident Management > View Workbench.
2. In the **Conference** tab, select the type of the call and click **Start Call**.
3. In the **Include a brief message for participants** field, type the message that you want to send to the conference call participants and click **Start Call**.
Initiate conference call

Conference Bridge
+14046204596

Add Participants
Email
User
Group
Phone
Email

Selected
System Administrator (Openen
Lucy Barnes (Incident Manage

Lucy Barnes (Incident Manager)

Users displayed in red do not have a mobile phone number

Include a brief message for participants

160 characters remaining of 160 characters

Cancel
Start Call
Note:
Upon clicking **Start Call** the message text entered will be stored as description on the conference call record. If the OOB workflow is not modified, then the workflow takes care of sending this message text as SMS to the user. This is applicable if you have configured a telephony provider.

**Viewing conference call information**

Conference calls are listed as system activities in the **Activity** section of the Incident Communication Plan form and also are listed in the **Conference Calls** related list.
List of Notify calls

If you are a Notify administrator, you can view a list of calls and the status of a call made to or from Notify. The call records help in reporting and analytics.

To view a list of calls, navigate to Notify > Calls.

Call records are generated automatically when a user calls a Notify number or when a user makes an outbound call through Notify. You cannot create call records manually.

**Note:** Although you can delete a call record, doing so may result in cascade deletion of related records.

For Notify calls where the source is specified, such as a task number, the source is added to the Notify Calls [notify_call] table in the Source column. For Notify conference calls where the source is specified, the source is added to the records for each of the calls in the conference.

<table>
<thead>
<tr>
<th>Call status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>initiated</td>
<td>The number has just been dialed</td>
</tr>
<tr>
<td>ringing</td>
<td>The call is currently ringing.</td>
</tr>
<tr>
<td>in_progress</td>
<td>The call was answered and is currently in progress.</td>
</tr>
<tr>
<td>no_answer</td>
<td>The call was not answered.</td>
</tr>
<tr>
<td>completed</td>
<td>The call was answered and has ended normally.</td>
</tr>
<tr>
<td>busy</td>
<td>The caller received a busy signal.</td>
</tr>
<tr>
<td>failed</td>
<td>The call could not be completed as dialed, most likely because the phone number was non-existent.</td>
</tr>
<tr>
<td>invalid</td>
<td>The call could not be connected since input is invalid.</td>
</tr>
<tr>
<td>unknown</td>
<td>The driver does not support the status</td>
</tr>
</tbody>
</table>

Use SMS with Notify

Send and receive SMS messages using Notify.

Notify stores inbound and outbound SMS messages in the Notify Messages [notify_message] table.

Notify supports sending concatenated SMS messages. Messages that exceed 160 characters, or 70 unicode characters, are split into multiple messages. This may affect your total telephony cost because each message can incur a cost. Some mobile carriers, such as Sprint, do not support concatenated SMS messages.

To send SMS messages to an individual recipient, use the Notify API sendSMS method. This method takes one recipient as an input parameter. You can also use the send SMS workflow activity.

To send SMS messages to one or more recipients, use the Notify API sendBulkSMS method. This method takes a list as an input parameter and uses one API call to send multiple messages. Include the list of phone numbers in an array in the API call. This method improves performance by streamlining platform checks and Notify number validation.
**Note:** When using `SNC.Notify.sendBulkSMS` API, instead of simply iterating over the numbers, all the given numbers will be sent for SMS to Twilio in one API call. This happens only when Twilio Direct driver is active and Twilio Notify bulk SMS is enabled for the number in Advanced SMS features.

The Notify-Twilio integration provides programmable SMS outbound message status tracking with Status Callbacks. These callbacks can be helpful to see if a message has been delivered, failed, or ran into some other delivery issues.

### SMS Statuses

Every Twilio SMS message request has a status value which describes the current state of the message. Use this information for troubleshooting SMS related incidents/ issues. Here are few descriptions of possible statuses of SMS sent from Notify through Twilio REST API.

#### Outbound message status progression

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>queued</td>
<td>The message has been queued by the provider to be sent to the carrier network.</td>
</tr>
<tr>
<td>accepted</td>
<td>The message is being processed by the provider before sending it to the carrier network.</td>
</tr>
<tr>
<td>sending</td>
<td>The message is being forwarded to the carrier network.</td>
</tr>
<tr>
<td>sent</td>
<td>The message has been successfully forwarded to the carrier network.</td>
</tr>
<tr>
<td>receiving</td>
<td>The provider has received an incoming message from the carrier network and is processing it.</td>
</tr>
<tr>
<td>received</td>
<td>ServiceNow has received the incoming message from the provider.</td>
</tr>
<tr>
<td>delivered</td>
<td>The message has been delivered to the target device.</td>
</tr>
<tr>
<td>undelivered</td>
<td>The message could not be delivered to the target device.</td>
</tr>
<tr>
<td>failed</td>
<td>The message failed to be forwarded to the carrier network.</td>
</tr>
<tr>
<td>unknown</td>
<td>The driver does not support the status.</td>
</tr>
</tbody>
</table>

**Note:** A provider may not be able to report this status if the upstream carrier does not report this.

### Send an SMS with Zoom meeting invite

Send an SMS with Zoom meeting invite to ensure that the meeting participants or any newly added participant is updated with the meeting details when the meeting host starts the conference or adds a participant to the conference.

Role required: notify_admin or admin

**Note:** You need a telephony provider like Twilio or Nexmo.
Note: The feature is compatible with ServiceNow version, New York with Patch 1 and later.

1. Navigate to Notify > Zoom > Configuration.
2. In the Run Workflow on conference change field, enter Notify Zoom: Send SMS on Conference Change.
   The Notify Zoom: Send SMS on Conference Change workflow is available with the demo data of the Notify Zoom Connector plugin (sn_notify_zoom).
3. Click Update.

Outbound communication requirements

Outbound communications initiated through Notify, such as phone calls and SMS messages, must satisfy recipient number requirements.

Recipient number requirements

These requirements apply to any number that receives a Notify phone call or message.

- The number must be E.164 compliant.
- The number must be different than the phone number used to initiate the call or message.

These requirements apply to all outbound communication initiated through Notify, such as by using Notify workflow activities or the Notify JavaScript API.

Invalid numbers prevent Notify workflows from running and cause an error to be logged. Set the glide.notify.debug property to true to create detailed error logs.

Using Notify with tasks

Notify allows you to initiate conference calls and send SMS alerts from task records.

This functionality is available for all tables that extend the Task table, such as incident, problem, or change request. All calls and messages made from tasks are initiated using a single Notify phone number (E.164 or short code). You can configure which phone number is used by setting the property glide.notify.task.phone_number.

Start a conference call from a task

Use Notify to start conference calls from a task record.

Role required: itil

Notify must be set up before you can use Notify on task. Ensure there are Notify phone numbers (E.164 or short code) in number groups with phone call workflows.

Use glide.enable.notify_on_task property to enable Notify integration for Task table and its extensions. Entering phone number in glide.notify.task.phone_number property is equivalent to setting glide.enable.notify_on_task to true.

1. Navigate to any task record, such as an incident or change request.
2. Click the Start conference call related link.
3. Select one or more Recipients to participate in the conference call.
4. Click **Start**.
   Any conference call records created from a task are associated with that task. You can view associated conference calls from the task record in the **Conference calls** related list. You may need to configure the form to add the related list.

**Manage conference calls on task**

Add and manage multiple participants on the conference including self-joining in to the conference call and end the conference call when the discussion is over.

- Role required: itil, itil_admin, or admin
- A conference call is already initiated.

The **Manage Conference Calls** UI action is available for any table that extends the Task [task] table. If at least one conference call is active on a task record, the link appears on the related links section of the form. Out of the tables that extend the task table, the **Manage Conference Calls** UI action is intentionally hidden for Incident Communication Plan [incident_alert] table and Communication Task [comm_task] table. For these two tables, the functionality is already available as **Join conference call** and **End conference call** UI actions.

1. Navigate to any task record such as Incident, Problem, or Change Request.
2. Open the record on which the conference all is active.
3. In the related links, click **Manage Conference Calls**.
4. In the Manage Conferences window, you can perform the following activities:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join Conference Call</td>
<td>If the logged in user is not already a part of the conference call, the user can join the conference.</td>
</tr>
<tr>
<td>Add Participants</td>
<td>Add participants to the conference who can contribute to the discussion.</td>
</tr>
<tr>
<td>End Conference Call</td>
<td>End the conference when the discussion is over.</td>
</tr>
</tbody>
</table>

5. Optional: In the Manage Conferences window, click the conference call number to know the details of the conference.

**Send an SMS alert from a task**

Use Notify to send SMS alerts from a task record to send any information related to the call.

Role required: itil

Notify must be set up before you can use Notify on task. Ensure there are Notify phone numbers (E.164 or short code) in number groups with SMS workflows.

Use `glide.enable.notify_on_task` property to enable Notify integration for Task table and its extensions. Entering phone number in `glide.notify.task.phone_number` property is equivalent to setting `glide.enable.notify_on_task` to true.

1. Navigate to any task record such as an incident or a change request.
2. Click the **Send SMS** related link.
3. In the **From** choice list, select the phone number from which you want to send the SMS message.
4. Select and add the participants to whom you want to send the SMS message. All users from the User Contacts list in the incident communication plan are in the Recommended section by default.

The dialog box displays the Recommended and Selected participants to whom you want to send an SMS message.

5. To select ad-hoc participants, choose one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the reference lookup icon and select the relevant user</td>
<td>Click Add to selected.</td>
</tr>
<tr>
<td>Enter the participant’s phone number</td>
<td>Click Add to selected.</td>
</tr>
</tbody>
</table>

6. After the participant list is finalized, type the message you want to send to the participants in the Message field and click Send SMS.

Any SMS records created from a task are associated with that task. You can view associated SMS messages from the task record in the SMS Messages related list. You might need to configure the form to add this related list.

**Using Notify with Incident Communications Management**

Use Notify with incident communication plan to send SMS messages or start conference calls.

Certain configuration steps are required to use Notify with an incident communication plan.

- Both Notify and Incident Communications Management must be active.
- Notify must be configured and able to initiate and receive phone calls and SMS messages.
- The property `com.snc.iam.notify_number` must be set to an active Notify number with outgoing voice and SMS capability.
- This Notify number must belong to a number group configured with inbound and outbound conference call workflows.

**Note:** The Conference Call Group number group is configured with conference call workflows by default.

**Initiate a conference call from incident communication plan**

Use Notify to initiate a conference call from an incident communication plan by inviting one or more users.

Role required: admin

1. Navigate to Incident Communications Management > All.
2. Open the relevant incident communication plan.
3. Click the Conference tab.
4. For the relevant incident communications task, under Actions, click Initiate Conference Call.
5. Select the conference bridge and the participants for the conference call.

   Available options in the conference bridge depend on the conference providers configured. For more information, refer Configure a provider in Notify.

**Join and end a conference call from incident communications management**

After a conference call is initiated, join the call to participate in the discussion or end the call when the conference is no longer required.
Role required: ia_admin or admin

1. Navigate to **Incident Communications Management > All.**
2. Open the relevant incident communication plan.
3. Click the **Conference** tab.
4. For the relevant incident communications task, under **Actions**, perform one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join Conference Call</td>
<td>If you are not already logged into the conference call, you can join the conference.</td>
</tr>
<tr>
<td>End Conference Call</td>
<td>End the conference when the discussion is over.</td>
</tr>
</tbody>
</table>

**Note:** The work notes get updated with the details of the conference call such as duration and participants.

---

### Send communication updates for an incident communications plan

Update users on the latest communication on an incident through selected communication channels.

- Role required: admin
- Activate the Notify plugin (com.snc.notify) if you want to send communication through SMS.
- Set at least one communication channel for a communication task as SMS or email.

1. Navigate to **Incident Communications Management > All.**
2. Open an incident communication plan record.
3. From the Incident Communication Tasks related list, open the incident communication task for which you want to send updates.
4. In the related links, click **Start Updates**.
5. Fill the required information and click **Send**.
   For sending an SMS communication, in the **From** choice list, select a number from which you want to send the communication.
6. Click **Send**.

---

### Using Notify with On-Call Scheduling

When using both Notify and On-Call Scheduling, you can send On-call escalation notifications as SMS messages, in addition to emails.

Certain configuration steps are required to use Notify with On-Call Scheduling.

- You must add at least one Notify phone number to the On-Call Group number group. This group is configured by default to handle inbound SMS responses (via On-Call: Check Assignment Response) that accepts or rejects an on-call assignment and to handle outbound voice calls (via On-Call: Assign by Acknowledgement Voice) to accept or reject assignments.
- You must configure workflows, such as the On-Call: Assign by Acknowledgement to drive escalations via SMS and Voice.

---

### Set up Notify with On-Call Scheduling

You can configure on-call scheduling to use Notify functionality to send SMS alerts and assign users to tasks based on the SMS responses.
Ensure that the Notify and On-Call Scheduling plugins on your instance are activated.
Role required: admin

Set up Notify with On-Call Scheduling for the first time or migrate from On-Call Scheduling with NotifyNow.

1. Navigate to Notify > Numbers.
2. Select the phone number you want to use to send and receive on-call scheduling messages.
3. In the Notify group field, select the On-Call Group.
   The On-Call Group is configured with the on-call workflows: On-Call: Check Assignment Response and On-Call: Assign by Acknowledgement Voice by default.
4. Navigate to Workflow > Workflow Editor.
5. Select the On-Call: Assign by Acknowledgement workflow.
   If migrating from NotifyNow, and you have previously customized this workflow, you must import the new version of the workflow manually. See KB0551603 for more information.
6. Click the workflow menu icon in the title bar and select Copy to copy the On-Call: Assign by Acknowledgement per rota workflow. Save the copied workflow under a different name than what it is named by default.
   **Note:** You must avoid modifying default workflows and instead choose to copy and then modify the required workflow.
7. Select a Send SMS activity.
8. In the To (script) field, modify the getRecipientsAndNumberToSendFrom() to use the correct from number's sys ID.
9. Close the Workflow Editor
10. Navigate to On-Call Scheduling > Trigger Rules.
11. Select a trigger rule that launches an assignment workflow
12. In the Trigger action field, select Workflow.
13. In the Trigger workflow field, select the On-call: Assign by Acknowledgement workflow.
14. Click Update.
15. Repeat the previous 3 steps for each assignment trigger rule.
   Each time the conditions for one of these trigger rules is met, the On-call: Assign by Acknowledgement workflow runs.

### Controlling the on-call communication channel with Notify

Configure On-Call Scheduling with Notify to always use a user's preferred communication channel.

If Force communication channel is specified in the Escalation settings for rosters, the preferred user device is used, either SMS, Voice or email.

For example, if the preferred device is SMS, and the on-call member does not have an SMS device defined, the user is not contacted even if the user has an email address. When forcing a communication channel on an escalation level does not succeed, no further communication attempts are made. The fact that the user could not be reached is logged.

### On-call: Assign by Acknowledgement workflow

The On-Call: Assign by Acknowledgement workflow is provided with Notify.

The workflow uses data from the escalation settings, including overlapping shifts and custom escalation settings, of shifts and rosters. Depending on these escalation settings, the workflow iterates through the defined escalation chain and sends notifications by SMS, email, or voice to users asking them for incident assignment. The workflow respects time-off as specified in the rosters. People who have time-off are not included in the escalation chain and no notifications are sent to them.
When you install both On-Call Scheduling and Notify, the message_number column is added to the Notify Messages [notify_messages] table to track responses to on-call assignment requests. This column indicates if the contacted user accepted or rejected the assignment. Before you can send notifications, you must define trigger rules. Trigger rules determine the conditions that must be met before a notification is sent and what action must be taken.

**Call a user from the WebRTC UI**

Make outbound calls and receive a voice call in the browser through the WebRTC interface from On-Call Schedules landing page, Roster and Escalation Details modal and on-call calendar.

Role required: itil

1. Navigate to **On Call scheduling > On Call calendars**.
2. In the calendar that opens, click the name of the user you want to call.
3. Choose **Call** to call the user.

**Key differences between on-call scheduling with NotifyNow and with Notify**

There are key differences between on-call scheduling with NotifyNow and on-call scheduling with Notify.
Tracking responses to questions

The On call: Assign by Acknowledgement workflow no longer uses the Notify Question tables to track assignment responses. When you install On-Call Scheduling with Notify, the message_number column is added to the Notify Messages [notify_messages] table to track responses to on-call assignment requests. This column indicates if the contacted user accepted or rejected the assignment.

Notify administration

As a Notify administrator, you can create number and number groups, create and modify workflows, update the tables and so on.

Numbers and number groups

Number groups allow you to group Notify phone numbers and share workflows across grouped numbers. Each phone number within Notify has an associated number group. Numbers within a group use the same workflows for handling incoming and outgoing calls and SMS messages.

Numbers associated with a group appear on the Notify Phone Numbers related list on the Notify Phone Number Group form.

If the number group workflows have incorrect conditions, a warning appears.

Create a number group

Group Notify phone numbers and share workflows across grouped numbers.

Role required: notify_admin

Each phone number within Notify has an associated number group. Numbers within a group use the same workflows for handling incoming and outgoing calls and SMS messages.
Numbers associated with a group appear on the **Notify Phone Numbers** related list on the Notify Phone Number Group form.

1. **Navigate to Notify > Number Groups.**

2. **Click New.**
3. Enter a **Name**, and select **Notify: (Re)join Conference Call** for the **Incoming call workflow** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the number group.</td>
</tr>
<tr>
<td>Incoming call workflow</td>
<td>Workflow to run when there is an incoming phone call for this group.</td>
</tr>
<tr>
<td>Incoming SMS workflow</td>
<td>Workflow to run when there is an incoming SMS message for this group.</td>
</tr>
<tr>
<td>Outgoing call workflow</td>
<td>Workflow to run when there is an outgoing phone call for this group.</td>
</tr>
<tr>
<td>Outgoing SMS workflow</td>
<td>Workflow to run when there is an outgoing SMS message for this group.</td>
</tr>
</tbody>
</table>


Short codes can only be associated with SMS workflow groups. You cannot add an incoming or outgoing call to a short code group.

4. Click **Submit**.

**Associate a number to a number group**

After creating a number group, associate numbers with that group to use the selected workflows.

**Note:** Each phone number can only be associated with one number group.
Associate a number to a number group

Associate a Notify number to a number group to use inbound and outbound workflows.

Role required: notify_admin

1. Navigate to Notify > Numbers.

2. Click the listed phone number and assign it to a **Number Group**, as appropriate.

**Note:** Each phone number can only be associated with one number group.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Number for the entry.</td>
</tr>
<tr>
<td>Phone number</td>
<td>E.164 phone number, if applicable.</td>
</tr>
<tr>
<td>Notify group</td>
<td>(Optional) Group to which this number is assigned.</td>
</tr>
</tbody>
</table>
3. Click **Update**.

**Configure a provider in Notify**

Configure a conference provider or a phone number to be used as choices for initiating a conference call. For sending SMS, configure preferences for phone numbers.

Role required: notify_admin

1. Navigate to **Notify > Provider Selector**.
2. Click **New**.
3. On the form, fill in the fields.

**Provider selector fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the provider you are adding.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the provider appears when multiple providers are configured.</td>
</tr>
<tr>
<td>Source table</td>
<td>The table to which this provider needs to be added.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions on the source table based on which provider selectors are applied.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates whether the provider is active.</td>
</tr>
<tr>
<td>Default</td>
<td>Makes this provider the default.</td>
</tr>
<tr>
<td>Manual selection</td>
<td>Disables the automatic selection of this provider, for example, if in a communication plan you want to use this provider only as a forced communication channel.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
5. In the **Provider Selector Choices** related link, click **New**.
6. Search for the conference provider or the Notify group that contains the phone numbers for initiating a conference.
   For sending SMS, search for the Notify group that contains the phone numbers.
7. Click **Submit**.

**Configure SMS opt-out preferences**

Allow recipients to opt out of receiving text messages.

Role required: admin, notify_admin

According to regulations in the CTIA Short Code Monitoring Handbook, recipients must be allowed to opt out of receiving text messages. The opt-out functionality is applicable only to Notify. When the user
sends an SMS message with an opt-out keyword to any Notify number, the user is opted out of receiving messages from only the Notify number to which the message has been sent, not from all Notify numbers on that instance.

**Important:** The Advanced opt-out feature is automatically enabled for short code and long code numbers associated with a Messaging Service. For more information, refer Getting Started with Advanced Opt-Out for Messaging Services. As this feature is a duplicate of the Twilio’s new Advanced Opt-out feature, you should not activate the feature for numbers that are part of Messaging Service. For long code numbers that are not part of a Messaging service, Twilio handles the opt-out for default stop keywords listed at Twilio support for opt-out keywords.

**Note:** This feature is disabled by default and holds significance for short-code and long codes that are not part of Messaging Service. To enable this feature, the Notify admin needs to create a configuration for short and long codes using the given procedure.

1. Navigate to **Notify > Administration > SMS Preference Configuration**.
2. Click **New** in the SMS Preference Configuration window.
3. On the form, fill in the fields.

### SMS configuration preference fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider</td>
<td>Select the provider for which you are configuring the SMS preferences.</td>
</tr>
<tr>
<td>Name</td>
<td>A user-friendly name for the configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the preference configurations apply. If you have multiple configurations, this field indicates which configuration to consider first.</td>
</tr>
<tr>
<td>Default preference</td>
<td>The default preference for the configuration. The two options are:</td>
</tr>
<tr>
<td>Enable for long code</td>
<td>Option that enables the opt-out feature for long code or toll-free numbers.</td>
</tr>
<tr>
<td>Enable for short code</td>
<td>Enables the opt-out feature for short codes only.</td>
</tr>
<tr>
<td>Opt-out keywords</td>
<td>Keyword replies that prevent a customer from receiving new messages from the phone number they’re responding to. You can configure standard keywords such as STOP, STOPALL, END, CANCEL, QUIT, and UNSUBSCRIBE.</td>
</tr>
<tr>
<td>Opt-out confirmation message</td>
<td>Customized confirmation message to send to customers when they opt out of receiving SMS messages.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opt-in keywords</td>
<td>Customized confirmation responses that enable customers to receive the messages coming from a phone number. You can configure standard keywords such as START, UNSTOP, and YES.</td>
</tr>
<tr>
<td>Opt-in confirmation message</td>
<td>A customized confirmation message to send to customers when they opt in to receiving SMS messages.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

### Notify workflow activities

Notify workflow activities manage calls and SMS messages in Notify.

All Notify workflows that manage a phone call must run on the `notify_call` table. Call-related Notify activities can be added only to workflows where the **Table** field value is **Notify Call [notify_call]**.

You can identify if an outbound call was answered by a human or by an answering machine from within a Notify workflow by evaluating the `current.is_human` variable, such as with an **If** workflow activity. This variable is set by the telephony provider when an outbound call is answered. This variable is always true for inbound calls.

**Note:** Do not add a **Timer** activity between multiple Notify activities that interact with active phone calls.

**Important:** When creating a Notify workflow, set the workflow **If condition matches** field to **None**. Notify controls which workflow to run based on the configured number groups.

### Join conference call workflow activity

The **Join Conference Call** activity connects an incoming or outgoing call to a Notify conference call.

Notify includes the workflows Notify: (Re)join Conference Call and Notify: Join Conference Call Via SMS to demonstrate how to use the **join conference call** activity to connect inbound and outbound calls, and inbound SMS messages to a conference call.

### Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Select this check box to record the conference call.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to display advanced configuration options.</td>
</tr>
<tr>
<td>Script</td>
<td>Specify advanced configuration options using JavaScript, such as if the new participant should be muted upon joining the conference call. You can access values from the workflow scratchpad.</td>
</tr>
</tbody>
</table>
Conditions

The conditions determine which transition comes after this activity. The join conference call activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the conference_call scratchpad variable is not set.

Scratchpad entries

The activity uses the workflow scratchpad to read persistent values.

<table>
<thead>
<tr>
<th>Scratchpad variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>workflow.scratchpad.conference_call</td>
<td>A GlideRecord for a single conference call record. A call processed by this activity is added to this conference call. If this value is not specified, the join conference call activity will log an error. When initiating an outgoing call workflow using the Notify API call(String notifyPhoneNumber, String toPhoneNumber, GlideRecord conferenceCall) method, this scratchpad value is set automatically to the conference call GlideRecord. For incoming call workflows, or workflows initiated using a different mechanism, you must explicitly set this scratchpad value.</td>
</tr>
</tbody>
</table>

Enable different attributes available with Join Conference Call activity

System administrators can enable any or all of the below attributes and use them in the Join Conference Call workflow activity.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hangupOnStar</td>
<td>When hangupOnStar is enabled (set to true), participants in a conference call can press the * button to disconnect from the call. Control is returned to the workflow, which can be used to trigger customer-defined actions.</td>
</tr>
<tr>
<td>muted</td>
<td>When muted is enabled (set to true), the participant will join the conference in a muted state.</td>
</tr>
<tr>
<td>beepOnEnter</td>
<td>When beepOnEnter is enabled (set to true), a notification beep is played when a user joins the conference.</td>
</tr>
<tr>
<td>beepOnExit</td>
<td>When beepOnExit is enabled (set to true), a notification beep is played when a user leaves the conference.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>enableImmediateInput</td>
<td>When enableImmediateInput is enabled (set to true), it allows input of a single digit immediately after the conference ends for this user and sets that in workflow.scratchpad.confDigits. This option will be ignored if hangupOnStar is false.</td>
</tr>
</tbody>
</table>

To enable any of the above attributes, perform the following steps:

1. Navigate to **Workflow > Administration > Workflow Versions**.
2. Open the Notify: (Re)join Conference Call workflow.
3. Click the **Show Workflow** related link.
4. To modify the workflow, click the WorkFlow Actions icon and click **Checkout**.
5. Open the Join Conference Call workflow activity.
6. Enable the **Advanced** check box to display the **Script** field.
7. Set the **hangupOnStar** attribute to true in the **config** variable in the script. The default setting is false.
8. Click **Update**.
9. Click the WorkFlow Actions icon and click **Publish** to save the changes.

Similarly, you can enable the other attributes.

**Call workflow activity**

The **Call** activity makes outbound phone calls using a Notify workflow. This workflow activity can be added to any table.

**Input variables**

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify Number</td>
<td>The Notify phone number to make the call from. When you initiate a call, the outgoing call workflow for the number group associated with this number runs.</td>
</tr>
<tr>
<td>Phone number to call</td>
<td>The E.164-compliant phone number to call.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to determine number to call, and the Notify number to call from instead of using the <strong>Phone number to call</strong> and <strong>Notify Number</strong> variables.</td>
</tr>
<tr>
<td>Script</td>
<td>Define a script that controls which number to call. This script should return a string listing the Notify number sys_id, as well as the phone number to call, such as {notify_number: ‘sys_id’, phone_number: ‘+316...’}</td>
</tr>
</tbody>
</table>
Conditions

The conditions determine which transition comes after this activity. The call activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the call could not be set up due to invalid data returned by the advanced script.

Send SMS workflow activity

The send SMS workflow activity to send short text messages using Notify to users’ phones. This workflow activity can be added to any table.

Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Select the Notify phone number to use to send the SMS message.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use JavaScript to determine which numbers to send the message to, and the Notify number to use to send the message.</td>
</tr>
<tr>
<td>To</td>
<td>Select any number of users to send the message to.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select any number of groups to send the message to.</td>
</tr>
<tr>
<td>To (groups)</td>
<td>Select any number of groups to send the message to.</td>
</tr>
<tr>
<td>Message</td>
<td>Enter the message to send. You can add field values from the current record by using the Select variables box. You can also add values from the workflow scratchpad. If a field and a scratchpad variable have the same name, the field value is used. Because you can use variables in this message, it is not possible to determine the length of the message at design time. If the activity sends a message that is longer than supported by the telephony provider, the message is truncated and the instance logs a warning.</td>
</tr>
</tbody>
</table>
### Variable

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To (script)</td>
<td>Enter a script to determine which numbers to send the message to, and the Notify number to use to send the message. The script should return a JavaScript object with the format `{notify_number: &quot;...sys_id...&quot;, users: [...], groups: [...], numbers: [...]} Specify the users or groups to send the message to as an array of sys_id values. Specify other numbers as an array of E.164-compliant phone numbers. This field appears only if Advanced is selected.</td>
</tr>
</tbody>
</table>

### Conditions

The conditions determine which transition comes after this activity. This activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the Notify number used to make the call is not configured correctly or unable to send SMS messages, or if an error occurs while sending the SMS.

### Forward call workflow activity

The **Forward Call** activity forwards a Notify call to an E.164-compliant phone number.

If the person receiving a forwarded call hangs up, the **forward call** activity completes and transitions to the next activity. Any further Notify activities in the workflow run for the caller only.

### Input variables

Input variables determine the initial behavior of the activity.

#### Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone number to call</td>
<td>Enter the phone number to forward the call to.</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>Enter the amount of time to wait for the call to be answered before hanging up.</td>
</tr>
<tr>
<td>Record</td>
<td>Select this check box to record the conversation.</td>
</tr>
</tbody>
</table>

### Conditions

The conditions determine which transition comes after this activity. The **forward call** activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the phone number to call is invalid.
**Input workflow activity**

The **Input** activity creates a phone menu by presenting a list of options on a Notify call.

**Input Variables**

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of digits</td>
<td>Specify the maximum number of digits the caller can enter. A caller can enter fewer digits than the maximum and press the <strong>Finish key</strong> to complete the entry.</td>
</tr>
<tr>
<td>Finish key</td>
<td>Specify the key a caller can press on their phone when finished selecting a menu option.</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>Specify the amount of time to wait before closing the menu automatically when the caller does not select a menu option.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to build the phone menu, instead of using the activity conditions.</td>
</tr>
</tbody>
</table>
Variable | Description
--- | ---
Script | Define the script to build the phone menu. The script must specify an `answer` variable as a JavaScript object with the following format:

```javascript
answer = {
    "1": {
        "play": "https://some_url.com/options/one.mp3",
        "myCustomData": "some data here"
    },
    "2": {
        "play": "https://some_url.com/options/two.mp3",
        "myCustomData": "some other data here"
    },
    "3": {
        "speak": "type 3 to speak to a representative",
        "language": "en-US",
        "myCustomData": "some more data here"
    }
};
```

The script may specify either a text-to-speech string and language code using the `speak` attribute or URL of the music to be played using the `play` attribute. You can also add optional attributes to store related information, such as `myCustomData` in the example above.

**Note:** The script object continues to support `say` attribute for backward compatibility.

### Conditions

The conditions determine the transition that comes after this activity.

The **input** activity does not specify any conditions by default. You must define conditions to build the phone menu. Each condition is one option on the phone menu. Notify reads the text from each condition **Name** to the caller, up to 100 characters per condition.

You can specify a language for each condition by prefixing the message with the language code, in the format `xx-XX:<Message>`. For example, add `fr-CA:` for Canadian French. Available languages are stored on the Notify Language `[notify_language]` table.

The condition that the activity transitions through depends on the digits entered by the caller. Set the condition **Condition** value to `parseInt(workflow.scratchpad.digits) == <expected digits>`. For example, to transition through a condition when the caller presses the number 3, set the **Condition** to `parseInt(workflow.scratchpad.digits) == 3`.

You can add an error condition to this activity. The activity transitions through the error condition if the advanced script returns an invalid value, or if the text to say for a condition is empty.
Scratchpad Entries

The activity uses the workflow scratchpad to write persistent values.

**Values written to scratchpad**

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>workflow.scratchpad.digits</td>
<td>The digits entered by the caller, as a string.</td>
</tr>
<tr>
<td>workflow.scratchpad.menu&lt;activity name&gt;</td>
<td>The entire answer variable, if using the advanced script option. You can access this menu from other activities after this activity successfully executes. For example, if the activity name is choices, you can access values from the menu using var previousActivity = &quot;choices&quot;; var choicesMenu = workflow.scratchpad.menu[previousActivity]; var menuItem = choicesMenu[workflow.scratchpad.digits]; // Selects the menu item based on the caller’s input. var selectedValue = menuItem.myCustomData; // get the custom data for the selected menu item.</td>
</tr>
</tbody>
</table>

Hangup workflow activity

The **Hangup** activity disconnects an active Notify phone call.

You can use the **hangup** activity to disconnect only calls that have been answered. Use the **reject** activity to disconnect calls that have not been answered.

Play workflow activity

The **Play** activity plays a sound file on a Notify call.

Input Variables

Input variables determine the initial behavior of the activity.

**Input Variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Enter the URL of a sound file to play. If the URL is inaccessible, or if the audio file mime type is not supported by the telephony provider, the play activity is skipped.</td>
</tr>
<tr>
<td>Loop</td>
<td>Enter the number of times the sound file should play.</td>
</tr>
</tbody>
</table>
Conditions

The conditions determine which transition comes after this activity. The play activity does not specify any conditions by default.

You can create an error condition to handle errors with the sound file. The activity transitions through the error condition if the specified sound file is not available, or has an unsupported mime type. Supported mime types are listed on the Notify Audio MIME Types [notify_mime_type] table.

Record workflow activity

The Record workflow activity records audio from a user on a Notify call.

Note: The Record workflow activity records call but not the conference call. To record the conference call, you can set the Record activity variable on the Join Conference Call workflow activity.

Input Variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max duration (in seconds)</td>
<td>Enter the maximum duration, in seconds, allowed for a recording.</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>Enter the amount of time to wait before ending a recording automatically when the caller is silent.</td>
</tr>
<tr>
<td>Finish Key</td>
<td>Specify the key a caller can press on their phone to end the recording.</td>
</tr>
</tbody>
</table>

Scratchpad Entries

The activity uses the workflow scratchpad to store persistent values.

The record activity adds the recording variable to the workflow scratchpad. This variable stores metadata about the recording, such as URI, ID, and duration. You can access the following values from this variable.

Values written to scratchpad

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>recording.recordingDuration</td>
<td>The duration of the recording, in seconds.</td>
</tr>
<tr>
<td>recording.from_number</td>
<td>The caller’s phone number, including country code.</td>
</tr>
<tr>
<td>recording.notify_number</td>
<td>The Notify phone number used to respond to the call, including country code.</td>
</tr>
<tr>
<td>recording.recordingID</td>
<td>The ID used by the telephony provider to identify the recording.</td>
</tr>
<tr>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------</td>
</tr>
<tr>
<td>recording.recordingURL</td>
<td>The URL from the telephony provider to access the recording.</td>
</tr>
</tbody>
</table>

### Reject workflow

The **Reject** workflow activity rejects an incoming Notify call.

You can use the **reject** activity to disconnect only calls that have not yet been answered. Use the **hang up** activity to disconnect calls that have been answered.

### Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reason</td>
<td>Select a reason for rejecting the call, such as <em>busy</em>.</td>
</tr>
</tbody>
</table>

### Say workflow activity

The **say** workflow activity allows you to play a message, using text to speech, on a Notify call.

### Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text to say</td>
<td>Specify the text to read.</td>
</tr>
<tr>
<td>Language</td>
<td>Select the language and locale to use when reading text.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to define the language and message, instead of using the Text to say and Language values.</td>
</tr>
<tr>
<td>Script</td>
<td>Define a script to set what text is read on the call. The script must return a string that defines the language and the text to read. For example, to play an English-language message, return (language: 'en-US', text: 'Text to read').</td>
</tr>
</tbody>
</table>

### Forward to notify client workflow activity

The **forward to notify client** workflow activity connects a phone call to a Notify WebRTC client.
Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Select the user to connect the call to.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to determine which client to connect to, instead of using the User variable.</td>
</tr>
<tr>
<td>Script</td>
<td>Define a script that controls which client to connect to. This script should return a GlideRecord for a single User [sys_user] record.</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>Enter the amount of time to wait for the call to be connected before hanging up.</td>
</tr>
<tr>
<td>Record</td>
<td>Select this check box to record the call.</td>
</tr>
</tbody>
</table>

Conditions

The conditions determine which transition comes after this activity. The Forward to Notify Client activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if there is an issue with the Notify client.

Queue workflow activity

The Queue activity places an active Notify call in a queue.

Add the Queue activity to a workflow on the Notify Call [notify_call] table to put the current call on hold. This activity does not specify any input variables.

The queue that the call is added to is given a random ID.

Notify activity event handlers

Notify workflow activities provide JavaScript functions that are invoked automatically when your telephony provider broadcasts certain events.

When the telephony provider broadcasts an event related to a Notify call, such as the caller hanging up, the event is processed by the workflow associated with that Notify call. All currently-executing Notify activities in that workflow invoke a JavaScript function associated with that event.

Not all activities that support an event provide a default event handler implementation. You can provide an implementation for those event handlers when creating custom Notify activities.

Creating Notify activities

Default Notify workflow generally performs a single action, such as initiating a phone call. You can create custom Notify workflow activities to implement more complex functionality.
Use event handler functions in each Notify activity definition to design your own activity behavior. For example, you can set the activity result if the caller hangs up by using the `onCompleted` function.

```javascript
onCompleted: function() {
  activity.result = 'call_ended';
},
```

When creating a new Notify workflow activity, follow these design principles.

- Within `onExecute` event handler function, create a new NotifyAction object. Use this object to create a simple or complex action, then serialize the object to the notify_wf_activity table.
- Within the `onUpdate` event handler function, deserialize the NotifyAction object from the notify_wf_activity table and use this object to perform any other operations.
- Use the other event handler functions and the Notify as needed to implement the desired activity behavior.

**Notify languages**

Notify supports multiple languages when using text-to-speech.

For example, when using the `input` or `say` workflow activities, you can specify which language to use when reading the text.

The list of available languages is stored on the Notify Languages [notify_language] table. By default, languages supported by all Notify telephony providers are available. You can add additional languages if they are supported by your specific telephony provider.

**Available Notify activity event handlers**

When creating Notify workflow activities, you can use event-handler functions to respond to events from a telephony provider.

Not all activities or telephony providers support all events. For example, the `Reject` activity ends the call before the caller connects so the `onNoAnswer` function is never invoked from this activity.

**Note:** When configuring an activity to respond to an event, ensure that your telephony provider supports that event.

The following table describes available event handlers and lists the Notify workflow activities that can invoke each handler.

<table>
<thead>
<tr>
<th>Handler</th>
<th>Description</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>onExecute</code></td>
<td>Runs when the activity first runs.</td>
<td>All call-related activities</td>
</tr>
<tr>
<td><code>onUpdate</code></td>
<td>Runs when the call record associated with the workflow is updated.</td>
<td>All call-related activities</td>
</tr>
<tr>
<td><code>onCompleted</code></td>
<td>Runs when a call ends.</td>
<td>All call-related activities</td>
</tr>
<tr>
<td><code>onRinging</code></td>
<td>Runs when a call starts ringing.</td>
<td>Forward call, call, join conference call, forward to notify client</td>
</tr>
<tr>
<td><code>onInProgress</code></td>
<td>Runs when both parties are connected on a call.</td>
<td>Forward call, call, join conference call, forward to notify client</td>
</tr>
<tr>
<td><code>onNoAnswer</code></td>
<td>Runs when a call is not answered.</td>
<td>Forward call, call, join conference call, forward to notify client</td>
</tr>
</tbody>
</table>
### Components installed with Notify

Several types of components are installed with the Notify application.

### Roles installed with Notify

Notify adds the following roles.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify administrator [notify_admin]</td>
<td>Administrator with privileges for Notify 2 functionality.</td>
<td>• workflow_admin&lt;br&gt;• workflow_creator&lt;br&gt;• workflow_publisher</td>
</tr>
<tr>
<td>Notify viewer [notify_view]</td>
<td>Can view notify content. This role has read-only access to the Notify Conference Calls table [notify_conference_call] and the Notify Conference Call Participants table [notify_participant]. The itil role inherits the notify_view role when the Incident Communications Management and the Notify plugins are activated.</td>
<td></td>
</tr>
</tbody>
</table>

### Tables installed with Notify

Notify adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify Conference Calls</td>
<td>A list of conference calls started using Notify</td>
</tr>
<tr>
<td>[notify_conference_call]</td>
<td></td>
</tr>
<tr>
<td>Notify Calls</td>
<td>A list of calls started using Notify</td>
</tr>
<tr>
<td>[notify_call]</td>
<td></td>
</tr>
<tr>
<td>Notify Call Queue</td>
<td>A list of calls that are in queue</td>
</tr>
<tr>
<td>[notify_queue]</td>
<td></td>
</tr>
<tr>
<td>Notify Call Status</td>
<td>List of possible statuses of calls, such as; initiated, ringing, etc.</td>
</tr>
<tr>
<td>[notify_call_status]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Notify Client Connected Sessions</td>
<td>List of the connected sessions</td>
</tr>
<tr>
<td>[notify_client_session]</td>
<td></td>
</tr>
<tr>
<td>Notify Conference Call Participants</td>
<td>List of the participants in a conference call</td>
</tr>
<tr>
<td>[notify_participant]</td>
<td></td>
</tr>
<tr>
<td>Notify Conference Call Participant Sessions</td>
<td>List of the associations of a call record and Notify participant record</td>
</tr>
<tr>
<td>[notify_participant_session]</td>
<td></td>
</tr>
<tr>
<td>Notify Messages</td>
<td>List of messages sent from/to Notify</td>
</tr>
<tr>
<td>[notify_message]</td>
<td></td>
</tr>
<tr>
<td>Notify Phone Numbers</td>
<td>List of phone numbers used by Notify to make calls and send messages</td>
</tr>
<tr>
<td>[notify_number]</td>
<td></td>
</tr>
<tr>
<td>Notify Phone Number Groups</td>
<td>List of phone number groups used by Notify to make calls and send messages</td>
</tr>
<tr>
<td>[notify_group]</td>
<td></td>
</tr>
<tr>
<td>Notify Languages</td>
<td>List of the languages that Notify supports when using text-to-speech workflow activities.</td>
</tr>
<tr>
<td>[notify_language]</td>
<td></td>
</tr>
<tr>
<td>Notify Recordings</td>
<td>List of conference call recordings</td>
</tr>
<tr>
<td>[notify_recording]</td>
<td></td>
</tr>
<tr>
<td>Notify Workflow Activity</td>
<td>List of Notify workflow activities</td>
</tr>
<tr>
<td>[notify_wf_activity]</td>
<td></td>
</tr>
<tr>
<td>Notify Audio MIME Types</td>
<td>List of audio file formats</td>
</tr>
<tr>
<td>[notify_mime_type]</td>
<td></td>
</tr>
<tr>
<td>Temporary Serialized Notify Action Cache</td>
<td>List of serialized Notify actions waiting to be processed</td>
</tr>
<tr>
<td>[notify_action]</td>
<td></td>
</tr>
<tr>
<td>Notify SMS Template</td>
<td>Contains the templates which are used while sending a Notify SMS.</td>
</tr>
<tr>
<td>[notify_sms_template]</td>
<td></td>
</tr>
</tbody>
</table>
Notify call sequence

Properties installed with Notify

Notify adds the following properties.

Properties for Notify

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_twilio_driver.max_conference_participants</td>
<td>Twilio maximum limit for number of participants in the conference call.</td>
</tr>
<tr>
<td>com.snc.iam.notify_number</td>
<td>The Notify number to use for conference calls.</td>
</tr>
</tbody>
</table>

**Note:** This number must have a group configured with conference call workflows.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.notify.task.phone_number</td>
<td>Notify phone number used for sending SMS-s and starting conference calls from any record that belongs to the task table (or a table that extends the task table). The number must be entered in E.164-compliant format.</td>
</tr>
<tr>
<td>glide.notify.sms.max_concatenation</td>
<td>Notify supports the concept of SMS concatenation. When the SMS body exceeds the maximum length of a single SMS (160 characters for plaintext SMS messages or 70 characters for Unicode SMS messages) Notify can concatenate up to 10 SMS messages which will be joined on the receiver’s mobile phone. This property configured the maximum number of SMS messages that will be concatenated into one large SMS message. If the body length is exceeded the body will be truncated and a message will be logged. Note: The charges are per sms, which means that 1600 character SMS will be 10 times as expensive as a 160 character SMS. Also note that not all providers support SMS concatenation.</td>
</tr>
<tr>
<td>glide.enable.notify_on_task</td>
<td>Use this property to enable Notify integration for Task table and its extensions. Entering phone number in 'glide.notify.task.phone_number' property is equivalent to setting this to true.</td>
</tr>
<tr>
<td>glide.notify.endpoint</td>
<td>If the instance is accessible on public internet using some other name, which can happen if the instance is within a private network and is accessible via a reverse proxy from outside. In that case the public name needs to be provided here. e.g. https://some_public_domain.com</td>
</tr>
<tr>
<td>glide.notify.sms.save_confirmation_in_db</td>
<td>Check Yes if you want track the confirmation of opt-in/out requests SMS. The confirmations are saved in notify_message table.</td>
</tr>
<tr>
<td>com.snc.iam.enable_notify</td>
<td>Use this property to enable Notify integration for Incident Communications Management. Entering phone number in ‘com.snc.iam.notify_number’ property is equivalent to setting this to true.</td>
</tr>
<tr>
<td>com.snc.iam.notify_number</td>
<td>The Notify number to use for conference calls. Note that this number needs to have a group configured with conference call workflows.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.notify_webrtc_number</td>
<td>Specify a valid Notify number with voice capability. This will enable On-Call integration with Notify which allows On-Call users to directly call people on rosters from the browser.</td>
</tr>
<tr>
<td>sn_major_inc_mgmt.notify_webrtc_number</td>
<td>Specify a valid Notify Number with voice capability. This will enable a specific Major Incident Management integration with Notify which allows Workbench users to directly call people from the browser.</td>
</tr>
</tbody>
</table>
Business rules installed with Notify

Notify adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Call Workflows for Shortcodes</td>
<td>[notify_group]</td>
<td>Checks and displays an error if the call is being triggered by a short code.</td>
</tr>
<tr>
<td>Update Participant Duration</td>
<td>[notify_participant]</td>
<td>Updates participant duration when it becomes inactive.</td>
</tr>
<tr>
<td>Check if Notify call exists and active</td>
<td>[notify_participant_session]</td>
<td>Checks if Notify call has valid reference record and updates it if the call is inactive currently.</td>
</tr>
<tr>
<td>Update Last Active On</td>
<td>[notify_participant]</td>
<td>Sets the last active before insertion/update of Notify participant.</td>
</tr>
<tr>
<td>Show info msg about selection in choice</td>
<td>[notify_group_selector_choice]</td>
<td>Displays a message if either Notify group or conference provider is not selected.</td>
</tr>
<tr>
<td>Validate values in the choice</td>
<td>[notify_group_selector_choice]</td>
<td>Checks if either of Notify group or conference provider is filled.</td>
</tr>
<tr>
<td>Set scratchpad values</td>
<td>[notify_group_selector_choice]</td>
<td>Checks if conference provider is available by iterating through service provider list.</td>
</tr>
<tr>
<td>Show message for empty choices</td>
<td>[notify_group_selector]</td>
<td>Displays an info message if there are no choices for the provider selector.</td>
</tr>
<tr>
<td>Clear fields when Manual Selection is set</td>
<td>[notify_group_selector]</td>
<td>Clears out some fields when manual selection is set in Notify group selector table.</td>
</tr>
<tr>
<td>Update Participant Duration</td>
<td>[notify_participant_session]</td>
<td>Calculates the duration of participant on conference call.</td>
</tr>
<tr>
<td>Update session muted state</td>
<td>[notify_participant]</td>
<td>Sets the value of mute and expelled to true once the conference call participant becomes inactive.</td>
</tr>
<tr>
<td>Update conference call</td>
<td>[notify_participant]</td>
<td>Sets the state of conference call based on the participant leaving or joining the call.</td>
</tr>
<tr>
<td>Validate Order field value</td>
<td>[notify_group_selector]</td>
<td>Validates order field value to be unique amongst all provider selectors.</td>
</tr>
<tr>
<td>Restrict Workflows For only Voice Nums</td>
<td>[notify_number]</td>
<td>Restricts association of voice only capable number with number group having inbound/outbound SMS workflows.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Restrict Workflows For only SMS Numbers</td>
<td>[notify_number]</td>
<td>Restrictions association of SMS only capable number with number group having inbound/outbound voice workflows.</td>
</tr>
<tr>
<td>Validations on default record</td>
<td>[notify_group_selector]</td>
<td>Validates that source table and order field are mandatory in case of default set to false and both fields empty in case of default set to true.</td>
</tr>
<tr>
<td>Clearing fields when Default is true</td>
<td>[notify_group_selector]</td>
<td>Clears out some fields when default is set to true.</td>
</tr>
<tr>
<td>No Default selector set</td>
<td>[notify_group_selector]</td>
<td>Ensures one active provider selector is set as default.</td>
</tr>
<tr>
<td>Check active default selector is unique</td>
<td>[notify_group_selector]</td>
<td>Ensures only one provider selector is set as default.</td>
</tr>
<tr>
<td>Process SMS preferences for incoming SMS</td>
<td>[notify_message]</td>
<td>When an SMS preference configuration defined for a particular telephony provider, then apply it for every incoming SMS.</td>
</tr>
<tr>
<td>Check default notify group is unique</td>
<td>[notify_group]</td>
<td>Validates that not more than one group is set as default Notify group.</td>
</tr>
<tr>
<td>Trigger conference end</td>
<td>[notify_conference_call]</td>
<td>When a conference call ends, triggers the notify.conference.end event</td>
</tr>
<tr>
<td>Update Call Active State</td>
<td>[notify_call_status]</td>
<td>Updates the status of the call in notify_call_status with the status received from Twilio.</td>
</tr>
<tr>
<td>Update Conference Call Active State</td>
<td>[notify_participant]</td>
<td>Updates the active flag in notify_participant table. Also calculates the duration when the call is ended by a participant.</td>
</tr>
<tr>
<td>Update Participant Active State</td>
<td>[notify_participant_session]</td>
<td>Updates the active flag for the participant (notify_participant), and calculates the total time on the call upon disconnecting from the call.</td>
</tr>
<tr>
<td>Update Participant Session Active State</td>
<td>[notify_call]</td>
<td>Synchronizes the state of the call between notify_call and notify_participant_session. Upon disconnecting from the call, updates notify_participant_session with the duration of the call.</td>
</tr>
<tr>
<td>Warn for incorrectly configured workflow</td>
<td>[notify_group]</td>
<td>Checks notify_group table and displays an error if the a workflow is not configured correctly.</td>
</tr>
</tbody>
</table>
**Orchestration**

ServiceNow® Orchestration extends the workflow engine to manage processes and to automate things outside of a ServiceNow instance.

Orchestration is available as a separate subscription from the rest of the ServiceNow platform. See Activate Orchestration for details.

**Explore**
- Introduction to Orchestration
- Orchestration applications
- Orchestration ROI
- Orchestration examples
- Domain separation in Orchestration

**Set up**
- Activate Orchestration
- MID Servers for Orchestration
- Available activity packs
- Setup Client Software Distribution

**Administer**
- List of Orchestration plugins
- Orchestration Runtime plugin

**Use**
- Orchestration activity packs
- Password Reset application
- Client Software Distribution

**Develop**
- Orchestration activity designer
- Orchestration custom activity templates
- Client software distribution extension framework
- Developer training

**Troubleshoot and get help**
- Ask or answer questions in the Orchestration forum
- Search the HI knowledge base for known error articles
- Contact ServiceNow Technical Support

**Introduction to Orchestration**

Orchestration automates simple or complex multi-system tasks on remote services, servers, applications, and hardware.

An Orchestration process can cross all management disciplines and interact with hosted services and all types of infrastructure elements. These capabilities provide a powerful system for managing IT and Business processes quickly and reliably.

Orchestrated solutions aide collaboration among teams by providing reusable data and versioning for both the workflows and the activities within them. Subject matter experts can create activities that are reusable to numerous workflow developers. When an activity requires a change, developers can see the downstream implication of the change immediately by knowing which workflows use the activity. Well-designed orchestrations never fail and apply human tasks to address errors as they arise.

**Orchestration tools**

Orchestration can make calls outside of a ServiceNow instance, directly to web services or through a MID Server to systems within corporate firewall. Orchestration also enables the creation reusable activities that wrapper Java Script functions for manipulating things inside the platform. Orchestration extends the Workflow editor by providing these features:

- Activity packs containing ready-to-use activities.
- Activity Designer, which enables developers to create custom activities without an over dependence to create scripts to orchestrate to third-party systems.
- Ability to create activity packs using Scoped Applications.
- A Databus for following the flow of data across orchestration activities.
Orchestration Core provides entitlements to use specific applications:

**Client Software Distribution**

An application that automates software delivery from the Service Catalog. Provides OOB support for SCCM. Partner solutions support Macs using JAMF. Other third-party solutions provide support through the extension framework.

**Password Reset**

An application for users to reset their password in Active Directory. It can expand to communicate with other third-party systems.

**Orchestration ROI**

Enables users to evaluate estimated costs and actual costs for tasks, automate these tasks, and track the ROI of these tasks.

**Systems that Orchestration can automate**

Orchestration can automate tasks such as employee onboarding, user access rights, server management, managed file transfers, and Security Operations Orchestration activities. For example, you might use the Active Directory and Exchange activities provided in the base Orchestration system to set up network accounts and mailboxes for new employees.

If Orchestration does not provide the activities you need for an integration, create the necessary activities using the templates in the Orchestration Activity Designer. The external systems that Orchestration can automate for:

- Any system exposing web services (SOAP, REST)
- Any system accessible from the command line (such as a UNIX system accessible through SSH, a Windows system enabled for PowerShell remoting or WMI)
- Numerous proprietary services: Windows Active Directory, Microsoft Exchange mail servers, InfoBlox, and F5 Networks.

**Note:** For a full list of Activity Pack service offerings, see Orchestration Core Activity Packs.

- Any filesystem accessible by SFTP
- Any database with a compliant JDBC driver
- Additional Activity Packs are also available with other ServiceNow products, such as Security Operations
Orchestration capabilities

Orchestration workflow

When an Orchestration activity starts within a workflow, Orchestration launches a probe and writes a probe record to the ECC Queue. The workflow pauses as the MID Server picks up the request and executes the
probe. When the probe reports back, the workflow resumes as the results are analyzed. The workflow can exit or continue at this point.

Orchestration workflow

Orchestration video tutorial

Watch the introductory video for Orchestration.

Domain separation in Orchestration

This is an overview of domain separation and Orchestration. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Support: Data only

Domain separation in this application is supported at the **Data only** level, meaning it supports the data security model of separating visibility of data from one domain to another. To learn more, see Application support for domain separation.

Activate Orchestration

The Orchestration (com.snc.runbook_automation) plugin is available as a separate subscription from the rest of the ServiceNow platform.

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and sub-production instances, generally within a few days.

If you do not have an account manager, decide to delay activation after purchase, or want to evaluate the product on a sub-production instance without charge, follow these steps.

Role required: none

1. Navigate to **System Applications** > **All Available Applications** > **All**.
2. On the All Applications page, click **Request Plugin** to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.

<table>
<thead>
<tr>
<th>Activate Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>In order to enhance the user experience, we have redesigned Activate a Plugin service catalog. Please use the new HI Service Portal &quot;Activate a Plugin&quot; service catalog item. You can also use Manage Instances page on Service Portal to Activate a Plugin.</td>
</tr>
<tr>
<td>Take me to the HI Service Portal Activate a Plugin Service Catalog.</td>
</tr>
</tbody>
</table>

4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click **Submit**.

**List of Orchestration plugins**

This table lists all plugins available for Orchestration and their dependencies.

These Orchestration plugins are available for purchase or can be requested as part of your Orchestration subscription. Contact your account representative for details.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orchestration [com.snc.runbook_automation]</td>
<td>Main plugin for the Orchestration feature. This plugin extends Workflow to automate operations with external systems. Use this plugin to orchestrate business services, applications, and infrastructure. This plugin automates operations such as deployments, configurations, and information gathering. Orchestration can automate Web Services and uses MID Servers to execute commands on devices inside an enterprise’s network.</td>
<td>• Orchestration - ROI  • Orchestration - Runtime</td>
</tr>
<tr>
<td>Orchestration - Active Directory [com.snc.orchestration.ad]</td>
<td>Installs the Active Directory activity pack. These activities create, delete, and manage objects in Windows Active Directory.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>Orchestration - Asset Lease Management [com.snc.orchestration.asset_lease_management]</td>
<td>Provides the software lease functionality for Client Software Distribution. Allows users to set start and end dates of software leases and to request an extension of a lease. <strong>Note:</strong> This plugin is not automatically enabled when Orchestration is active.</td>
<td>None</td>
</tr>
<tr>
<td>Orchestration - Azure Active Directory [com.snc.orchestration.azure.ad]</td>
<td>Installs the Azure AD activity pack. These activities automate employee onboarding and offboarding functions on Azure Active Directory and manage Office 365 licensing.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>Orchestration - Client Software Distribution [com.snc.orchestration.client_sf_distribution]</td>
<td>Allows the distribution of software from the service catalog using third party management systems, such as Microsoft System Center Configuration Manager (SCCM). <strong>Note:</strong> This plugin is not automatically enabled when Orchestration is active.</td>
<td>• Orchestration - System Center Configuration Manager  • Orchestration - Asset Lease Management  • Service Catalog Scoped API  • Software Asset Management</td>
</tr>
<tr>
<td>Orchestration - Exchange [com.snc.orchestration.exchange]</td>
<td>Installs the Exchange activity pack. These activities manage Microsoft Exchange mail systems.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>Orchestration - F5 network management [com.snc.orchestration.f5]</td>
<td>Installs the F5 Network Management activity pack. These activities configure elements of an F5 load balancer, including pools, pool members, and the virtual servers contained in the pool.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>Orchestration - Infoblox DDI Activity Pack [com.snc.orchestration.infoblox]</td>
<td>Installs the Infoblox DDI activity pack. These activities support Infoblox DDI management.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Dependencies</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Orchestration - PowerShell [com.snc.orchestration.powershell]</td>
<td>Installs the PowerShell activity pack. These activities control and automate the administration of Windows machines and applications, using the Windows .NET Framework.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>Orchestration - Probe [com.snc.orchestration.probe]</td>
<td>Installs the Probe activity pack. These activities run ServiceNow® probes on target hosts to return specific information.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>Orchestration - ROI [com.snc.runbook_automation.roi]</td>
<td>Installs an Orchestration application that estimates savings resulting from automated tasks in an instance and computes actual savings. Orchestration - ROI is activated automatically with a base Orchestration subscription.</td>
<td>• Performance Analytics • Cost Management</td>
</tr>
<tr>
<td>Orchestration - ROI Premium [com.snc.runbook_automation.roi_premium]</td>
<td>Installs a premium dashboard that displays detailed reports on calculated savings for automated tasks over time. The Orchestration - ROI Premium plugin requires purchase and activation of the Performance Analytics - Premium plugin to display its reports.</td>
<td>• Orchestration - ROI • Performance Analytics - Premium</td>
</tr>
<tr>
<td>Orchestration - Runtime [com.snc.runbook_automation.runtime]</td>
<td>Enables other applications on the ServiceNow® platform to automate tasks, without requiring an Orchestration subscription. The Orchestration - Runtime plugin displays the Orchestration activities shipped with these applications in the Workflow Editor and allows customers to modify the activities without requiring an Orchestration license.</td>
<td>• Workflow Runtime Engine • Core Automation</td>
</tr>
<tr>
<td>Orchestration - SFTP [com.snc.orchestration.sftp]</td>
<td>Installs the SFTP File Transfer activity pack. These activities manage files and directories on an SFTP server and move files from one SFTP server to another.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>Orchestration - SSH [com.snc.orchestration.ssh]</td>
<td>Installs the SSH activity pack. These activities read, write, and copy files, and reset user passwords on Linux computers.</td>
<td>Orchestration</td>
</tr>
<tr>
<td>Orchestration - System Center Configuration Manager [com.snc.orchestration.sccm_mgnt]</td>
<td>Installs the System Center Configuration Manager (SCCM) activity pack. These activities manage software deployments and collections on an SCCM server.</td>
<td>Orchestration</td>
</tr>
</tbody>
</table>

**Orchestration Runtime plugin**

The Orchestration – Runtime plugin enables other applications on the ServiceNow® platform to automate tasks, without requiring an Orchestration subscription.
The Orchestration – Runtime plugin can be activated as part of another plugin or application. It is used by strategic technology partners and ServiceNow applications to distribute activity packs to customers who may not own Orchestration. For example, the Security Incident Response Management (SIRM) application provides orchestration content, which includes activities that are available from the Packs tab in the Workflow Editor. Customers who purchase SIRM can consume and modify the activities that SIRM ships without having to purchase an Orchestration license.

**Included with the plugin**

The Orchestration – Runtime plugin provides access to the Packs and Data tabs in the Workflow Editor. This plugin gives users access to custom activities for their applications and enables them to reuse data from the Databus. This plugin does not provide access to custom Orchestration activity packs or to the activity designer. The Custom tab in the Workflow Editor is not available without an Orchestration subscription.

---

**Orchestration plugin relationships**

**Dependencies**

The Orchestration – Runtime plugin activates these application plugins:
- Security Incident Response Orchestration
- Service Release Automation

**Access to activities**

Custom activities shipped with ServiceNow® applications are available in the **Packs** tab of the Workflow Editor for use in workflows. To edit these activities, navigate to **Orchestration > Activity Designer Activities** and select the activity you want to modify. For information about the provider templates used to create these activities, see **Orchestration custom activity templates**.

**List of Orchestration activities**

Use Orchestration activities in a Workflow to integrate with third-party systems.

Several Orchestration activities have been rewritten as **scoped** activities using the **activity designer** and grouped into **activity packs**. Other non-scoped activities are deprecated and may or may not appear in the Workflow Editor. However, all deprecated activities still function in existing workflows that use them.

**Global activities**

These activities run in the global scope only. Any activities you create in the global scope are organized in the Global category in the **Packs** and **Custom** tabs in the Workflow Editor.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Server Alive</td>
<td>Runs a command (including shell scripts) on a Linux or UNIX computer via SSH to validate whether the target system is alive.</td>
</tr>
</tbody>
</table>

**Active Directory (AD) activities**

All AD Orchestration activities were rewritten in the Geneva release as scoped activities and are available in the Active Directory activity pack. All previous version AD activities that were built on activity definitions are deprecated and are unavailable for use in new workflows.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create AD Object</td>
<td>Creates a user account in Windows Active Directory when a user account is created in a ServiceNow instance.</td>
</tr>
<tr>
<td>Disable AD User Account</td>
<td>Marks a Windows Active Directory user account disabled, making it inactive.</td>
</tr>
<tr>
<td>Enable AD User Account</td>
<td>Enables a Windows Active Directory user account, making it active.</td>
</tr>
<tr>
<td>Query AD</td>
<td>Retrieves entries from the Windows Active Directory based on a search filter.</td>
</tr>
<tr>
<td>Remove AD Object</td>
<td>Deletes a user account from Windows Active Directory.</td>
</tr>
</tbody>
</table>
### Azure AD

All these activities are scoped and part of the Azure AD activity pack. They do not have legacy versions.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add User to Group</td>
<td>Adds a user to an existing security group in Azure Active Directory.</td>
</tr>
<tr>
<td>Assign User License</td>
<td>Assigns an extra Office 365 software license to the named user.</td>
</tr>
<tr>
<td>Create User</td>
<td>Creates a user for the Azure Active Directory tenant.</td>
</tr>
<tr>
<td>Delete User</td>
<td>Deletes the named user’s account from the Azure Active Directory tenant.</td>
</tr>
<tr>
<td>Get User Info</td>
<td>Returns the named user's information from the Azure Active Directory.</td>
</tr>
<tr>
<td>Remove User from Group</td>
<td>Removes an existing user from a security group in Azure Active Directory.</td>
</tr>
<tr>
<td>Remove User License</td>
<td>Revokes the specified Office 365 software license for the named user.</td>
</tr>
<tr>
<td>Reset User Password</td>
<td>Changes the named user's Azure Active Directory password.</td>
</tr>
</tbody>
</table>

### F5 Network Management activities

All these activities are scoped and part of the F5 Network Management activity pack. They do not have legacy versions.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add F5 Pool</td>
<td>Creates the load balancer pool.</td>
</tr>
<tr>
<td>Check F5 Pool</td>
<td>Checks the status of a pool to validate whether it is available to accept traffic.</td>
</tr>
<tr>
<td>Delete F5 Pool</td>
<td>Deletes an F5 pool.</td>
</tr>
<tr>
<td>Add F5 Pool Member</td>
<td>Adds a member to an F5 pool.</td>
</tr>
</tbody>
</table>
### Infoblox activities

All these activities are scoped and part of the Infoblox DDI activity pack. They do not have legacy versions.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>List Registered Networks</td>
<td>Retrieves all the networks associated with an Infoblox server.</td>
</tr>
</tbody>
</table>

**Microsoft Exchange activities**

All Exchange Orchestration activities were rewritten in the Geneva release as scoped activities and are available in the Exchange activity pack. All previous version Exchange activities that were built on activity definitions are deprecated and are unavailable for use in new workflows.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Address List</td>
<td>Creates an address list that acts as an alias for emailing all users in the group. This alias cannot be used to manage user permissions.</td>
</tr>
<tr>
<td>Delete Address List</td>
<td>Removes an existing address list from an Exchange server.</td>
</tr>
<tr>
<td>Get Address List</td>
<td>Retrieves all attributes from the specified Exchange address list.</td>
</tr>
<tr>
<td>Move Address List</td>
<td>Moves an Exchange address list to another location in the address hierarchy.</td>
</tr>
<tr>
<td>Set Address List</td>
<td>Modifies an Exchange address list.</td>
</tr>
<tr>
<td>Update Address List</td>
<td>Adds or removes users from the specified address list and immediately applies any cached address list changes to the server.</td>
</tr>
<tr>
<td>Create Mailbox</td>
<td>If a user does not exist, creates a new Active Directory user and associated Exchange mailbox.</td>
</tr>
<tr>
<td>Delete Mailbox</td>
<td>Deletes the Exchange mailbox of an Active Directory user.</td>
</tr>
<tr>
<td>Disable Mailbox</td>
<td>Disables the mailbox associated with a specified Active Directory account.</td>
</tr>
<tr>
<td>Enable Mailbox</td>
<td>Creates a mailbox for an existing Active Directory user.</td>
</tr>
<tr>
<td>Get Mailbox</td>
<td>Gets the mailbox for the specified user or all mailboxes on an Exchange server.</td>
</tr>
<tr>
<td>Set Mailbox</td>
<td>Modifies the settings of an existing Exchange mailbox.</td>
</tr>
</tbody>
</table>

**PowerShell activities**

These PowerShell activities were rewritten as scoped activities and are available in the PowerShell activity pack. All previous version PowerShell activities that were built on activity definitions are deprecated and are unavailable for use in new workflows.
### ServiceNow, DocVersion, Now Platform capabilities

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Windows App</td>
<td>Installs an application on a Windows target machine.</td>
</tr>
<tr>
<td>Join Domain</td>
<td>Joins a Windows machine to a domain.</td>
</tr>
<tr>
<td>Uninstall Windows App</td>
<td>Uninstalls an application from a Windows target machine.</td>
</tr>
<tr>
<td>Change Service State</td>
<td>Starts or stops a Windows service on a remote system.</td>
</tr>
</tbody>
</table>

**Probe activities**

These probe activities were rewritten as scoped activities and are available in the Probe activity pack. All previous versions of these activities that were built on activity definitions are deprecated and are unavailable for use in new workflows.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolve DNS Name</td>
<td>Resolves an IP address or a fully qualified domain name (FQDN) into one or more IP addresses.</td>
</tr>
<tr>
<td>SNMP Query</td>
<td>Queries an SNMP device.</td>
</tr>
</tbody>
</table>

**SCCM activities**

All these activities are scoped and part of the SCCM activity pack. They do not have legacy versions.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to Device Collection</td>
<td>Adds a device to a Microsoft System Center Configuration Manager (SCCM) device collection.</td>
</tr>
<tr>
<td>Add to User Collection</td>
<td>Adds a user to a Microsoft System Center Configuration Manager (SCCM) user collection.</td>
</tr>
<tr>
<td>Get Applications</td>
<td>Returns a list of all the applications available on a Microsoft System Center Configuration Manager (SCCM) server.</td>
</tr>
<tr>
<td>Get Deployments</td>
<td>Returns the list of deployments performed by Orchestration using a Microsoft System Center Configuration Manager (SCCM) server.</td>
</tr>
<tr>
<td>Get Device Collections</td>
<td>Returns the list of available device collections on a Microsoft System Center Configuration Manager (SCCM) host.</td>
</tr>
<tr>
<td>Get User Collections</td>
<td>Returns the list of available user collections on a Microsoft System Center Configuration Manager (SCCM) host.</td>
</tr>
<tr>
<td>Remove from Device Collection</td>
<td>Removes a device from a Microsoft System Center Configuration Manager (SCCM) device collection.</td>
</tr>
</tbody>
</table>
### SSH activities

These SSH activities were rewritten as scoped activities and are available in the SSH activity pack. The SSH activities not converted to scoped activities were moved to the Orchestration - Deprecated category, but are still available for all workflows.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove from User Collection</td>
<td>Removes a user from a Microsoft System Center Configuration Manager (SCCM) user collection.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Copy</td>
<td>Copies a file on a Linux or Unix computer, via SSH.</td>
</tr>
<tr>
<td>File Read</td>
<td>Reads a file on a Linux or Unix computer, via SSH.</td>
</tr>
<tr>
<td>File Write</td>
<td>Writes a file on a Linux or UNIX computer.</td>
</tr>
<tr>
<td>File Replace String</td>
<td>Finds and replaces a string in a file on a Linux or UNIX computer.</td>
</tr>
<tr>
<td>Files Compare</td>
<td>Compares two files on a Linux or Unix computer, via SSH.</td>
</tr>
<tr>
<td>Reset Linux User Password</td>
<td>Resets the password for a given user on a Linux computer.</td>
</tr>
<tr>
<td>Secure Copy</td>
<td>Copies a file from one host to another, without storing the copied file on the MID Server.</td>
</tr>
</tbody>
</table>

### SFTP activities

All these activities are scoped and part of the SFTP File Transfer activity pack. They do not have legacy versions.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy File</td>
<td>Copies a file from an SFTP server (source host) to another SFTP server (target host).</td>
</tr>
<tr>
<td>Create Directory</td>
<td>Creates a directory on an SFTP server.</td>
</tr>
<tr>
<td>Get File List</td>
<td>Returns a list of files from a given directory and its subdirectories on an SFTP server (source host).</td>
</tr>
<tr>
<td>Remove File or Directory</td>
<td>Removes a file or a directory on an SFTP server, including subdirectories, when configured.</td>
</tr>
<tr>
<td>Rename File or Directory</td>
<td>Renames a file or directory to a new name on an SFTP server.</td>
</tr>
</tbody>
</table>
### Activity

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Set File Attributes</strong></td>
<td>Sets common file attributes, such as timestamps, size, permissions, and UID/GID, for a file or directory on an SFTP server.</td>
</tr>
</tbody>
</table>

### Deprecated activities

These activities have been removed from the Workflow Editor and are not available for new workflows, but continue to work normally in existing workflows. You can reactivate the deprecated activity or duplicate the functionality of a deprecated activity as a scoped activity by recreating it using the activity designer.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Run Probe</strong></td>
<td>Launches a MID Server probe on behalf of a document.</td>
</tr>
<tr>
<td><strong>SOAP Request</strong></td>
<td>Executes a SOAP request on a target server. The SOAP Message activity replaces this activity.</td>
</tr>
<tr>
<td><strong>Run Command</strong></td>
<td>Runs a command (including shell scripts) on a Linux or UNIX computer.</td>
</tr>
<tr>
<td><strong>Run SCP</strong></td>
<td>Uses Secure Copy Protocol (SCP) to copy a file from one computer to another, including the directory in which the file resides. The Secure Copy activity replaces the Run SCP activity.</td>
</tr>
<tr>
<td><strong>Run Powershell</strong></td>
<td>Executes Windows PowerShell commands on a MID Server.</td>
</tr>
</tbody>
</table>

### Available activity packs

Activity packs are available with your subscription to Orchestration.

**Role required:** admin

The following activity packs are available and active with your Orchestration subscription:

- Orchestration - Active Directory (com.snc.orchestration.ad)
- Orchestration - Azure Active Directory (com.snc.orchestration.azure.ad)
- Orchestration - Exchange (com.snc.orchestration.exchange)
- Orchestration - SFTP (com.snc.orchestration.sftp)
- Orchestration - Infoblox DDI Activity Pack (com.snc.orchestration.infoblox)
- F5 Network Management activity pack (com.snc.orchestration.f5)
- Orchestration - SSH (com.snc.orchestration.ssh)
- Orchestration - PowerShell (com.snc.orchestration.powershell)
- Orchestration - System Center Configuration Manager (com.snc.orchestration.sccm_mgmt)

1. Navigate to **System Applications > All Available Applications > All.**
2. On the All Applications page, click **Request Plugin** to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.

4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click Submit.

**Deprecated Orchestration activities**

These Orchestration activities have been deprecated.

**Run Probe**

The Run Probe activity launches a MID Server probe on behalf of a document. All Orchestration activities that launch a probe on a target machine are based on the Run Probe activity. Your ServiceNow instance must have access to a MID Server configured to use SSH to run this activity.

**Attention:** This activity is deprecated and is unavailable for new workflows. To replace the functionality of this probe, use the Probe activity template to create a custom activity. Workflows from a previous release that use the Run Probe activity can continue to do so.
Run Probe input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Probe</td>
<td>Select a MID Server probe from the list. This is the name of the probe as it appears in the discovery_probes table.</td>
</tr>
<tr>
<td>Source for probe</td>
<td>Enter the IP address of the host system against which the probe runs (the probe’s target).</td>
</tr>
<tr>
<td>Sensor script</td>
<td>The script to run using the results of the probe. The output from the probe is contained in a variable called output. Any error from the probe is contained in a variable called error.</td>
</tr>
</tbody>
</table>

SOAP Request

The SOAP Request activity executes a SOAP request on a target server.

Attention: This activity is deprecated and is replaced by the SOAP Message workflow activity activity. Workflows from a previous release that use the SOAP Request activity can continue to do so. However, this activity is not available for new workflows.

SOAP Request input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOAP URL</td>
<td>The SOAP endpoint.</td>
</tr>
<tr>
<td>Username</td>
<td>User name for basic authentication credentials.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for basic authentication credentials.</td>
</tr>
<tr>
<td>Envelope Script</td>
<td>Script for setting up parameters for the web service.</td>
</tr>
<tr>
<td>Sensor Script</td>
<td>The script to execute after the request has been made and a response has been received.</td>
</tr>
</tbody>
</table>

Reactivate a deprecated activity

Orchestration activities that were converted to activity packs are deprecated for upgraded and new instances but can be reactivated for use in new workflows.

Role required: workflow_admin, admin

Note: Reactivation of deprecated activities for use in new workflows is discouraged. Legacy activities cannot use the unique features of the scoped applications, such as reuse of data from the databus and input variable testing.

1. Navigate to Workflow > Administration > Activity Definitions.
2. In the list of activities, clear the condition **Category != deprecated** from the filter.

3. Open the definition record for the activity you want to reactivate.
4. Select the **What to Display** tab.
5. In the **Category** field, replace the value **deprecated** with another category. This can be an arbitrary string.
6. Click **Update**.

The system creates a new category using the value provided and reactivates the activity, which becomes available in the **Core** tab of the Workflow Editor.

**SOAP Message workflow activity**

The **SOAP Message** activity uses SOAP messages defined in the System Web Services plugin and can call the messages using a MID Server.

Your instance must have access to a MID Server configured to use SOAP.

**Input variables**

**SOAP Message activity input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOAP Message</td>
<td>soap_message</td>
<td>The SOAP Message defined under the System Web Services plugin's Outbound SOAP Message [sys_soap_message] table. (System Web Services &gt; Outbound &gt; SOAP Message)</td>
</tr>
<tr>
<td>SOAP Message Function</td>
<td>soap_message_function</td>
<td>The function to call that is defined in the SOAP Message. Functions are listed in the SOAP Message Functions related list in each SOAP Message record.</td>
</tr>
<tr>
<td>SOAP Endpoint</td>
<td>soap_endpoint</td>
<td>Endpoint to use instead of the SOAP endpoint value in the SOAP Message Function record. Leave this field blank to use the defined endpoint in the SOAP Message Function record.</td>
</tr>
<tr>
<td>Field</td>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Variables        | variables       | Variables to substitute into the SOAP Envelope defined in the SOAP Message Function record. Use this format for the string:  
|                  |                 | name1=value1, name2=value2, ...  
|                  |                 | If either the name or value contains a comma or equal sign, escape these characters with a backslash. |
| Use MID Server   | use_midserver   | Check box for using a MID Server to send the SOAP message. A MID Server might be necessary to reach an endpoint within a firewall or a sub-network that is not visible from the instance. If this check box is selected (true), but no MID Server is defined in the MID Server field, workflow automatically attempts to find a MID Server. |
| MID Server       | midserver       | Name of the MID Server to use. This field appears when you select the Use MID Server check box. The workflow ignores this parameter if the use_midserver parameter is disabled.  
|                  |                 | **Note:** You can only select a specific MID Server in the legacy SOAP message activity and REST messages. These legacy activities do not use the MID Server selection criteria available starting with the Istanbul release. |
| Sensor Script    | sensor_script   | The script to execute after the request has been made and a response has been received. You can access the full XML response body from the activity.output object. |

**Probes used by Orchestration**

Certain probes, controlled by MID Servers, perform Orchestration tasks on remote computers, such as restarting a server or creating virtual machines from templates.
**How Orchestration probes work**

When a Workflow executes an Orchestration activity, that activity launches a probe, which writes an output record to the ECC Queue. The MID Server selected for the activity checks the ECC Queue for assignments, and then executes the appropriate probe to do the work on the target machine. The information about the activity (machine restarted, files copied, etc.) that is returned from the target machine by the probe is written to the ECC Queue as an input record. This information is then sent from the ECC Queue to a sensor that is built into the Workflow activity. The Workflow is updated, and the next activity is executed.

**Note:** The probe parameters are set by the activities that launch the probe.

**How Orchestration uses probes**

**Probe List**

The base system includes the following Orchestration probes (**Orchestration > Definition > Probes**).

**Probe List**

<table>
<thead>
<tr>
<th>Probe Name</th>
<th>ECC Queue Topic</th>
<th>ECC Queue Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>Command</td>
<td></td>
<td>A probe that runs a local command on the MID server.</td>
</tr>
<tr>
<td>DNS Name Resolver</td>
<td>DNSNameResolver</td>
<td></td>
<td>A probe that resolves a fully qualified domain name (FQDN) into an IP address. The probe executes MID Server queries in parallel. It utilizes DNS lookup by the MID Server host OS to make use of the OS maintained DNS cache. It also leverages the hosts file on the OS.</td>
</tr>
<tr>
<td>Probe Name</td>
<td>ECC Queue Topic</td>
<td>ECC Queue Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------</td>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SCPCommand</td>
<td>SCPCommand</td>
<td></td>
<td>A probe that copies files securely from one machine to another. The copy function is performed using the MID Server as a tunnel.</td>
</tr>
<tr>
<td>Shazzam</td>
<td>Shazzam</td>
<td></td>
<td>A probe that identifies active devices.</td>
</tr>
<tr>
<td>SNMPProbe</td>
<td>SNMP</td>
<td>SNMP Query</td>
<td>This is a generic SNMP probe.</td>
</tr>
<tr>
<td>SOAPProbe</td>
<td>SOAPProbe</td>
<td></td>
<td>A probe that sends a SOAP request to target machine.</td>
</tr>
<tr>
<td>SSHCommand</td>
<td>SSHCommand</td>
<td></td>
<td>A probe that executes shell scripts from a command line after logging in to a target machine via SSH.</td>
</tr>
<tr>
<td>SSHCommandLong</td>
<td>SSHCommandLong</td>
<td></td>
<td>A probe that executes long running shell scripts from a command line after logging in to a target machine via SSH.</td>
</tr>
<tr>
<td>VMWare</td>
<td>VMWareProbe</td>
<td></td>
<td>A generic VMware probe that executes the MID Server script included in the <strong>ECC queue name</strong> that is set by a VMware Orchestration activity. This probe can run any MID Server script include.</td>
</tr>
<tr>
<td>Probe Name</td>
<td>ECC Queue Topic</td>
<td>ECC Queue Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Windows - PowerShell | PowerShell       | Windows - PowerShell | A probe that runs a Windows PowerShell script on the MID Server. The PowerShell script is provided as the value of a parameter with name ending in `.ps1`. Two variables are available to the script:  
  - `$computer`: The computer pointed to as the source for this probe  
  - `$cred`: A PowerShell credential, using a user name and password from the Credentials table, that logs into `$computer` successfully. |

**PowerShell activities**

PowerShell is built on the Windows .NET Framework and is designed to control and automate the administration of Windows machines and applications.

PowerShell must be installed on any MID Server that uses these activities. MID Servers using PowerShell must be installed on a supported Windows operating system. ServiceNow supports PowerShell 2.0 and above. PowerShell 3.0 does not support Windows 2003 Server.

The ServiceNow Orchestration plugin adds these basic PowerShell activities to workflows. For instructions on using activities from the PowerShell activity pack, see PowerShell activity pack

*Legacy Run PowerShell activity*

The Run PowerShell activity executes Windows PowerShell commands on a MID Server.

**Attention:** This activity is deprecated and is unavailable for new workflows. To replace the functionality of this activity, use the Powershell activity template to create a custom, scoped activity. Workflows from a previous release that use the Run PowerShell activity can continue to do so.

**Result Values**

The workflow designer can assign a result value using activity.result from within a script field of the activity. By default, the success or failure of the PowerShell commands used determines the result value of the Run PowerShell activity. Possible result values are:

- Success
- Failure
Scratchpad Entries

Information written to `stdout` by the executing script is captured and returned to the activity in the `activity.output` variable. This information can be parsed, processed, or saved (to a scratchpad variable, for example) for future processing in the activity’s sensor script.

An example would be to run the `get-date` command to get the MID Server’s current time. This sensor script saves the full output received, but we can process it to return and save only the time.

```
// save full output for a later processing in scratchpad variable 'currentdatetime'
workflow.scratchpad.currentdatetime = activity.output;
// Process the output and fetch the time and store it in a scratchpad variable 'time'
var time = $<date>$<time>$<date>$<time>$<date>$<time>$<time>$<date>$<time>
workflow.scratchpad.time = time / time[1]; // No time found;
```

PowerShell activity

**Note:** This is an over-simplified example. In most cases, the script operates against some remote Windows computer. However, the principal is the same – whatever is written to `stdout` is returned in `activity.output` and available to process.

Input Variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>IP address of the target Windows machine. This value is mapped to the <code>$computer</code> variable for use in commands (see the example in the <code>Command</code> field). A PowerShell credential variable called <code>$cred</code> that is based on information in the ServiceNow Credentials table will authenticate on the computer pointed to by <code>Hostname</code>.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>Enter the PowerShell command to run. For example, to execute a simple WMI query against a remote machine pointed to by the <em>hostname</em> variable, the command is:</td>
</tr>
<tr>
<td></td>
<td><code>get-wmiobject &lt;class&gt; -computer $computer -credential $cred</code></td>
</tr>
<tr>
<td></td>
<td>If no credentials authenticate on the computer, the command runs in the context of the MID Server user. You cannot run both a command and a script file. Specifying a command hides the <em>Script file</em> variable.</td>
</tr>
<tr>
<td>Sensor script</td>
<td>The script to run using the results of the probe. The output from the probe is contained in a variable called <em>output</em>. Any error from the probe is contained in a variable called <em>error</em>.</td>
</tr>
<tr>
<td>Script file</td>
<td>The MID Server script file to run. You cannot run both a script file and a command. Selecting a script file hides the <em>Command</em> variable.</td>
</tr>
<tr>
<td>PowerShell script variables</td>
<td>Additional parameters, in JSON format, used by the specified script file.</td>
</tr>
</tbody>
</table>

### States

The activity state tells the workflow engine what to do with the activity.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the onExecute function of the activity.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was cancelled.</td>
</tr>
</tbody>
</table>

Add workflow variables for the command line using the normal workflow variable syntax. In the example above, if the `<class>` was in a workflow input variable called *myclass*, the command would look like:

```powershell
get-wmiobject $(workflow. inputs. myclass) -computer $computer -credential $cred
```

Similarly, if the variable is a scratchpad variable named *myclass*, the command would look like:

```powershell
get-wmiobject $(workflow. scratchpad. myclass) -computer $computer -credential $cred
```
**HResult codes**

When a PowerShell script encounters an error, the Windows machine may return an HResult code as part of the error message.

PowerShell activities can read and interpret this code. Not all PowerShell errors include an HResult code. In the event of a failed PowerShell script, you can use the HResult code to move the workflow through a specific condition.

For example, when resetting an Active Directory password to a password that does not meet policy requirements, such as minimum length or complexity, the PowerShell script returns the HResult code -2146022651. To use this code, create an activity condition with the **Condition** value of `activity.hresult = -2146022651`. If the PowerShell script returns this code when the activity runs, the workflow transitions through this new condition.

**SSH activities**

SSH activities allow workflows to perform operations on Linux and Unix computers.

Your ServiceNow instance must have access to a MID Server configured to use SSH to run these Orchestration activities.

**Run Command activity**

The **Run Command** activity runs a command (including shell scripts) on a Linux or UNIX computer.

**Attention**: The Run Command activity is deprecated in this release. If you have a workflow created in a previous version that uses this activity, your workflow will continue to work normally after upgrading to Helsinki. However, to use this functionality in a new workflow, you must create a custom activity using the SSH activity template in the ServiceNow activity designer.

**Input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long running</td>
<td>Select this check box to disable the SSH connection timeout if you think the command will take longer to run than the default 60 seconds. Orchestration periodically checks the running process to determine its status until it is finished.</td>
</tr>
<tr>
<td>Hostname</td>
<td>Hostname or IP address of destination server for SSH activity.</td>
</tr>
<tr>
<td>Directory</td>
<td>Name of the working directory.</td>
</tr>
<tr>
<td>Command</td>
<td>The command to run from this activity.</td>
</tr>
<tr>
<td>Sudo</td>
<td>Select this check box to use <code>sudo</code> to run the command on the host machine.</td>
</tr>
<tr>
<td>Sensor script</td>
<td>The script to run using the results of the probe. The output from the probe is contained in a variable called <code>output</code>. Any error from the probe is contained in a variable called <code>error</code>.</td>
</tr>
</tbody>
</table>
Run SCP activity
The Run SCP activity uses Secure Copy Protocol (SCP) to copy a file from one computer to another, including the directory in which the file resides.

**Note:** This activity is deprecated in the Geneva release and is not available for use in new workflows. If you have a workflow created in a previous version that uses this activity, your workflow will continue to work normally after upgrading. The custom Secure Copy activity replaces the Run SCP activity in the Geneva release.

### Input variables

#### Run SCP input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Host</td>
<td>Hostname or IP address of the source computer.</td>
</tr>
<tr>
<td>From File</td>
<td>Absolute path to the file to copy. This value can be a directory.</td>
</tr>
<tr>
<td>To Host</td>
<td>Hostname or IP address of the target computer.</td>
</tr>
<tr>
<td>To File</td>
<td>Path to the target file. This path can be absolute or relative to the logged in user's home directory. The specified directory must already exist on the target computer.</td>
</tr>
<tr>
<td>Copy Directory</td>
<td>Check box to copy a directory defined in the From File variable and all files contained in that directory.</td>
</tr>
</tbody>
</table>

### Orchestration applications

Orchestration provides several applications with your subscription.

#### Orchestration ROI

The Orchestration ROI application allows you to estimate and compute cost savings for tasks in your system that could be automated with Orchestration.

After you automate the tasks, you can track cost savings by associating Orchestration workflows with corresponding task areas. Configuration in the application allows you to select the hourly rate for performing the task manually, the rules the system uses to select tasks for evaluation, and the time period of the evaluation. Orchestration ROI estimates your savings by multiplying the cost of performing repetitive tasks manually by the estimated number of times the system performs those tasks automatically during a specific date/time range. The system also calculates the actual savings of your automations. Orchestration ROI is included with the base Orchestration subscription.

Orchestration ROI reports offer a number of views of the comparative data and allow you to access the associated records directly from the reports. The standard reports included with the Orchestration - ROI plugin provide summaries, estimated costs, and calculated costs for automated processes. The ROI premium dashboard uses Performance Analytics to provide detailed reports on calculated savings over time. Performance Analytics requires a different plugin and subscription.

**Note:** When Orchestration ROI is activated as a dependent plugin of Orchestration, demo data is not installed. If you want to use demo data as a template for your own ROI evaluation, submit a
To set up Orchestration ROI, complete the configuration tasks in the order shown here.

**Create Orchestration ROI labor rate cards**

Before calculating your Orchestration ROI, you must create labor rate cards for the manual work that would be required to complete the tasks correlated to the ROI calculations.

Role required: orchestration_manager

The hourly rates defined in the rate cards are used to determine the savings from your orchestrated tasks.

1. Navigate to Orchestration > ROI > Labor Rate Cards.
2. Complete the fields in the form using the descriptions in #unique_2221.
3. Click Submit.
4. Create additional rate cards as needed.

**Create an Orchestration ROI automation entry record**

The ROI automation entry record couples the cost of performing a task with the specific workflow that automates the task, for the purpose of calculating the resulting savings.

Role required: orchestration_manager

Before starting this procedure, verify that the appropriate labor rate cards were created.

Use this record to apply a manual hourly rate to a task that is performed automatically by your instance. To determine the savings realized from orchestrating a task, the system can evaluate whether those savings were estimated or calculated.

- **Estimated savings**: Uses the labor rate, the time estimates for completion of the task, and the number of automations that have been run to determine savings.
- **Calculated savings**: Uses the labor rate, the time calculated for completion of the task, based on the configured evaluation period, and the number of automations that have been run to determine savings.

1. Navigate to Orchestration > ROI > Automation Entry Form.
2. Fill in the fields on the form, as appropriate.

**Automation Entry Form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Category of the selected workflow automation. The following categories are provided in the base Orchestration - ROI system:</td>
</tr>
<tr>
<td></td>
<td>• Access &amp; Identity Management</td>
</tr>
<tr>
<td></td>
<td>• Datacenter Automation</td>
</tr>
<tr>
<td></td>
<td>• IT Service Management</td>
</tr>
<tr>
<td></td>
<td>• Other</td>
</tr>
</tbody>
</table>

**Note:** To create a category, open the dictionary record for the Automation Entry Form [automation_entry_form] table and add an option to the choice list.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item</strong></td>
<td>Unique name for the specific task within the category. This value represents the work to which the labor rate card applies, such as Password Reset.</td>
</tr>
<tr>
<td><strong>Resource</strong></td>
<td>Labor rate card to apply to this automation entry. You must have IT Cost Management active on the instance for this field to appear.</td>
</tr>
<tr>
<td><strong>Associated Workflows</strong></td>
<td>Workflow automations created to automate this manual task. The system uses this field to identify the number of automations that have been run.</td>
</tr>
<tr>
<td><strong>Estimated Duration (min) per Task</strong></td>
<td>Estimated time to perform this task manually.</td>
</tr>
<tr>
<td><strong>Estimated Volume per Month</strong></td>
<td>Estimated number of times needed to perform this task manually per month.</td>
</tr>
</tbody>
</table>

### Read-only fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start time</strong></td>
<td>Start time for the evaluation period. Configure this value in the Time Range for Calculated Averages module.</td>
</tr>
<tr>
<td><strong>End time</strong></td>
<td>End time of the evaluation period. Configure this value in the Time Range for Calculated Averages module.</td>
</tr>
<tr>
<td><strong>Calculated average duration per task (min)</strong></td>
<td>Actual time required to perform this task manually.</td>
</tr>
<tr>
<td><strong>Calculated average volume per month</strong></td>
<td>Actual average number of times this task is performed manually per month.</td>
</tr>
</tbody>
</table>

### 3. Select one of these submission options:

- **Submit**: Saves the record to the table without running any calculations.
- **Submit and process now**: Saves the record and calculates the savings based on the hourly rate and the number of workflow contexts for this automation entry.

---

**Create an Orchestration ROI correlated task rule**

The correlated task rule applies configurable conditions to fields in a selected table that tell the instance which manual tasks correspond to an automation entry record.

Role required: orchestration_manager

Before starting this procedure, make sure you have created labor rate cards and the appropriate automation entry records for the automated tasks you want to evaluate.

Create conditions that the system can use to correlate manual tasks to the automation entry. For example, a rule on the Incident [incident] table uses these conditions to correlate the employee on-boarding task to values configured in the Employee OnBoarding automation entry record:

- **[Subcategory] [is] [Employee OnBoarding]**
- **[Sort description] [contains] [new employee]**
When a new employee opens an incident to request services or assets which are typically handled manually, Orchestration applies the usual labor rate for the manual work to the potential automated solution, and then computes the actual savings.

1. Navigate to Orchestration > ROI Task Correlation > Correlated Tasks Rules.
2. Click New.
3. Fill in the fields on the form, as appropriate.

**Automation entry form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automation entry</td>
<td>Automation entry record that correlates to the manual task defined by these conditions. The entry record names the workflow used to automate the task and defines the labor rate used to calculate the cost of the task.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to filter, using these conditions. The rule selects records from this table that match the conditions. Information from these records is used to calculate the actual time to perform a manual task and the actual volume for that manual task.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition builder to use to filter records for this table. Use these conditions to identify all manual tasks correlated to this automation entry.</td>
</tr>
<tr>
<td>Read-only fields</td>
<td></td>
</tr>
<tr>
<td>Processed on</td>
<td>Date and time that the system performs the matching records lookup. The system automatically searches for new manual tasks matching these conditions.</td>
</tr>
</tbody>
</table>

4. Select one of these submission options:
   - **Submit**: Saves the record to the table without running any calculations.
   - **Submit and process now**: Saves the record, looks up all matching tasks, and saves matching record information to the Correlated Tasks [manual_mapping_records] table.

5. To view a rule, select the link in the Table column of the Correlated Tasks Rules related list for the automation entry you want to see.
6. To view the list of tasks that match all correlated rules in the system, navigate to Orchestration > ROI Task Correlation > Correlated Tasks.
7. To view the list of tasks that match this rule in the system, click Correlated Tasks under Related Links in this form

**Configure the time range for Orchestration ROI calculations**

Select a date range to calculate the average number of tasks and the duration per month for the correlated tasks.

Role required: orchestration_manager

By default, the system creates a range ending at the current date and time and extending back over the previous month. You can change this range at any time and recalculate the ROI instantly.

1. Navigate to Orchestration > ROI Task Correlation > Time Range for Calculated Averages.
2. Enter a new start or end date and time or click the icon to select a date using the calendar.
3. Click **Calculate** to recalculate the ROI based on the new time range and to save your settings.

### Installed with Orchestration ROI

Several types of components are installed with the Orchestration - ROI plugin (com.snc.runbook_automation.roi).

**Tables installed with Orchestration ROI**

Tables are added with activation of Orchestration ROI.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense and Savings</td>
<td>Contains the data for the reports in Orchestration &gt; ROI Reports &gt; Predicted Savings.</td>
</tr>
<tr>
<td>[run_rate_predicted_savings]</td>
<td></td>
</tr>
<tr>
<td>Savings Report</td>
<td>Contains the number of automations that have been run before the date specified in the Processed On column, based on:</td>
</tr>
<tr>
<td>[savings_report]</td>
<td>• Each automation entry’s associated workflows</td>
</tr>
<tr>
<td></td>
<td>• Estimated savings based on the estimated duration per task.</td>
</tr>
<tr>
<td></td>
<td>• Calculated savings based on calculated duration.</td>
</tr>
<tr>
<td>Detailed Savings Report</td>
<td>Contains a detailed list for the Savings Report [savings_report] table. This list contains each automation’s run date and savings for that automation.</td>
</tr>
<tr>
<td>[detailed_savings_report]</td>
<td></td>
</tr>
<tr>
<td>Automation Entries</td>
<td>Contains automation entries that couple labor resources to specific manual tasks. You can specify the estimated duration to perform a task manually and the estimated number of times that a task is performed per month. If this automation entry already has workflow automations implemented, you can specify the associated workflows. The system calculates the savings, based on the labor rate card and the number of workflow automations that have been performed.</td>
</tr>
<tr>
<td>[automation_entry_form]</td>
<td></td>
</tr>
<tr>
<td>Roadmap Planning</td>
<td>Contains roadmap planning for each automation entry to be implemented. You can provide estimated hours to implement a workflow automation, the automation percentage anticipated by the end of the year, and the starting month to implement the workflow.</td>
</tr>
<tr>
<td>[roadmap_planning]</td>
<td></td>
</tr>
<tr>
<td>Correlated Tasks</td>
<td>Contains all matching manual tasks for each automation entry. Each task’s information is stored in this table for the system to use to calculate the actual duration and volume for each manual task.</td>
</tr>
<tr>
<td>[manual_mapping_records]</td>
<td></td>
</tr>
<tr>
<td>Correlated Tasks Rules</td>
<td>Contains the correlated task rules the system uses to look up manual tasks corresponding to each automation entry.</td>
</tr>
<tr>
<td>[manual_mapping_conditions]</td>
<td></td>
</tr>
</tbody>
</table>

### Plugins installed with Orchestration ROI

Plugins are installed with activation of Orchestration ROI, if they are not already active.
<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Management [com.snc.cost_management]</td>
<td>Provides the labor rate cards Orchestration ROI uses to determine the savings for each automated task. See #unique_2228 for more information.</td>
</tr>
</tbody>
</table>

**Roles installed with Orchestration ROI**

Roles are added with activation of Orchestration ROI.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orchestration manager [orchestration_manager]</td>
<td>Manages all activities in the Orchestration ROI module.</td>
<td>• pa_admin  • report_admin</td>
</tr>
</tbody>
</table>

**UI actions installed with Orchestration ROI**

UI actions are added with activation of Orchestration ROI.

**UI actions for Orchestration - ROI**

<table>
<thead>
<tr>
<th>UI action</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Savings Report</td>
<td>Automation Entry Form [automation_entry_form]</td>
<td>Displays the savings report specific to this automation entry, if the associated workflows are not empty.</td>
</tr>
<tr>
<td>Estimated and Projected Savings</td>
<td>Automation Entry Form [automation_entry_form]</td>
<td>Displays the estimated savings, based on the estimated duration of the task, and calculated savings, based on the calculated duration of the task.</td>
</tr>
<tr>
<td>Submit AND process now</td>
<td>Automation Entry Form [automation_entry_form]</td>
<td>Processes this new entry</td>
</tr>
<tr>
<td>Correlated Tasks</td>
<td>Correlated Tasks Rules [manual_mapping_conditions]</td>
<td>Displays all matching tasks from the Correlated Tasks [manual_mapping_records] table.</td>
</tr>
<tr>
<td>Detailed Savings Report</td>
<td>Automation Entry Form [automation_entry_form]</td>
<td>Displays the list of automations that have been run, based on associated workflows.</td>
</tr>
<tr>
<td>Task</td>
<td>Correlated Tasks [manual_mapping_records]</td>
<td>Displays the task record.</td>
</tr>
<tr>
<td>Submit AND process now</td>
<td>Correlated Tasks Rules [manual_mapping_conditions]</td>
<td>Processes a correlated task rule. This action performs matching on the specified table and the filter conditions.</td>
</tr>
</tbody>
</table>
ServiceNow | DocVersion | Now Platform capabilities

**Script includes installed with Orchestration ROI**
Script includes are added with activation of Orchestration ROI.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OrchestrationROIAjax</td>
<td>Script that calculates the actual duration and volume of a task.</td>
</tr>
<tr>
<td>OrchestrationROI</td>
<td>Script that calculates the number of workflow contexts, looks up all matching tasks, calculates savings, and other functions used in the UI actions.</td>
</tr>
<tr>
<td>ROIDemoDataUtil</td>
<td>Script that updates demo data timestamps.</td>
</tr>
</tbody>
</table>

**Client scripts installed with Orchestration ROI**
Client scripts are added with activation of Orchestration ROI.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display info for processing rules</td>
<td>Correlated Tasks Rules [manual_mapping_conditions]</td>
<td>Displays annotation on the Correlated Task Rule form advising that new task rules are not evaluated until the time specified in the ROI schedule.</td>
</tr>
</tbody>
</table>

**Business rules installed with Orchestration ROI**
Business rules are added with activation of Orchestration ROI.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete corresponding records</td>
<td>Automation Entry Form [automation_entry_form]</td>
<td>When a record is deleted from the Automation Entry Form [automation_entry_form] table, this business rule deletes all records in other ROI tables that reference this entry.</td>
</tr>
<tr>
<td>Insert into Run Rate &amp; Savings</td>
<td>Automation Entry Form [automation_entry_form]</td>
<td>When a new automation entry is provided, this business rule calculates the estimated savings, based on the estimated duration of a task and its associated labor rate card.</td>
</tr>
<tr>
<td>Insert into Savings Reports</td>
<td>Automation Entry Form [automation_entry_form]</td>
<td>When a new automation entry is provided, this business rule inserts a new record into the Savings Report [savings_report] table with the <code>automations_run</code> field set to 0.</td>
</tr>
</tbody>
</table>

**Orchestration ROI reports**

Orchestration ROI provides a collection of standard and premium reports to help you calculate savings from automating services in your organization.

The ROI standard reports are included with Orchestration ROI. The premium reports provide enhanced views generated with Performance Analytics and require the Orchestration - ROI Premium plugin.
Orchestration ROI standard reports
The dashboard of standard ROI reports provides summaries, estimated costs, and calculated costs for automated processes. To access the ROI standard dashboard, navigate to Orchestration > ROI Reports > Dashboard.

Summary tab
The Summary tab contains four reports on automation categories.
ROI summary report sample
Standard ROI summaries by category

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Tasks by Category Over Time</td>
<td>Trend of manual tasks by category over time. For example, if you use automations to perform a portion of the necessary tasks, the report shows the number of tasks still executed manually, decreasing over time.</td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong>: Line chart&lt;br&gt;<strong>Table</strong>: Detailed Savings Report [detailed_savings_report]</td>
</tr>
<tr>
<td>Automations by Category Over Time</td>
<td>Trend of automated tasks by category over time. For example, this chart can show the increase in the number of automated tasks as a workflow automation rolls out slowly over time.</td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong>: Line chart&lt;br&gt;<strong>Table</strong>: Detailed Savings Report [detailed_savings_report]</td>
</tr>
<tr>
<td>Automation Savings by Category Over Time (Uses Estimated Duration)</td>
<td>Amount of savings from automated tasks over time, based on the estimated duration of the task, the number of automations performed, and the cost from the labor rate card.</td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong>: Line chart&lt;br&gt;<strong>Table</strong>: Detailed Savings Report [detailed_savings_report]</td>
</tr>
<tr>
<td>Automation Savings by Category Over Time (Uses Calculated Duration)</td>
<td>Amount of savings from automated tasks over time, based on the calculated duration of the task, the number of automations performed, and the cost from the labor rate card.</td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong>: Line chart&lt;br&gt;<strong>Table</strong>: Detailed Savings Report [detailed_savings_report]</td>
</tr>
</tbody>
</table>

Estimated Costs tab

The Estimated Costs tab contains eight reports on estimated time and expense for automations.
ROI estimated time and expense report samples

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Standard ROI time and expense estimates

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimated Time Spent by Task Category</td>
<td>Total estimated time spent, in minutes, on all tasks by task category.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Pie chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Automation Entry Form [automation_entry_form]</td>
</tr>
<tr>
<td>Estimated Volume of Manual Tasks per Month by Category</td>
<td>Total estimated volume of all tasks per month by task category.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Pie chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Automation Entry Form [automation_entry_form]</td>
</tr>
<tr>
<td>Predicted Hours Spent Monthly by Category (Uses Estimated Duration &amp; Volume)</td>
<td>Total predicted hours spent monthly on all manual tasks by category, using the estimated duration of each task and the estimated volume of each task per month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Bar chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Expense and Savings [run_rate_predicted_savings]</td>
</tr>
<tr>
<td>Predicted Monthly Expense by Category (Uses Estimated Duration &amp; Volume)</td>
<td>Total predicted monthly expense for all manual tasks by category, using the estimated duration of each task, estimated volume of each task per month, and the cost from the labor rate card.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This report uses negative numbers to express an expense.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Bar chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Expense and Savings [run_rate_predicted_savings]</td>
</tr>
<tr>
<td>Predicted Hours Spent Quarterly by Category (Uses Estimated Duration &amp; Volume)</td>
<td>Total predicted hours spent quarterly on all manual tasks by category, using the estimated duration of each task and the estimated volume of each task per month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Bar chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Expense and Savings [run_rate_predicted_savings]</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Predicted Quarterly Expense by Category</td>
<td>Total predicted quarterly expense for all manual tasks by category, using the estimated duration of each task, estimated volume of each task per month, and the cost from the labor rate card.</td>
</tr>
<tr>
<td>Uses Estimated Duration &amp; Volume</td>
<td></td>
</tr>
<tr>
<td>Predicted Hours Spent Annually by Category</td>
<td>Total predicted hours spent annually on all manual tasks by category, using the estimated duration of each task and the estimated volume of each task per month.</td>
</tr>
<tr>
<td>Uses Estimated Duration &amp; Volume</td>
<td></td>
</tr>
<tr>
<td>Predicted Annual Expense by Category</td>
<td>Total predicted annual expense for all manual tasks by category, using the estimated duration of each task, estimated volume of each task per month, and the cost from the labor rate card.</td>
</tr>
<tr>
<td>Uses Estimated Duration &amp; Volume</td>
<td></td>
</tr>
</tbody>
</table>

**Costs from Correlated Tasks tab**

The Costs from Correlated Tasks tab contains eight reports on time and expense for automations based on actual calculations.
ROI calculated time and expense report samples
<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Spent by Task Category</td>
<td>Total actual time spent, in minutes, on all tasks by task category.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Pie chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Automation Entry Form</td>
</tr>
<tr>
<td></td>
<td>[automation_entry_form]</td>
</tr>
<tr>
<td>Volume of Manual Tasks per Month by Category</td>
<td>Total actual volume of all tasks per month by task category.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Pie chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Automation Entry Form</td>
</tr>
<tr>
<td></td>
<td>[automation_entry_form]</td>
</tr>
<tr>
<td>Projected Hours Spent Monthly by Category (Uses Calculated Duration &amp; Volume)</td>
<td>Total projected hours spent monthly on all manual tasks by category, using the calculated duration of each task and the calculated volume of each task per month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Expense and Savings</td>
</tr>
<tr>
<td></td>
<td>[run_rate_predicted_savings]</td>
</tr>
<tr>
<td>Projected Monthly Expense by Category (Uses Calculated Duration &amp; Volume)</td>
<td>Total projected monthly expense for all manual tasks by category using the calculated duration of each task, the calculated volume of each task per month, and the cost from the labor rate card.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Note</strong>: This report uses negative numbers to express an expense.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Expense and Savings</td>
</tr>
<tr>
<td></td>
<td>[run_rate_predicted_savings]</td>
</tr>
<tr>
<td>Projected Hours Spent Quarterly by Category (Uses Calculated Duration &amp; Volume)</td>
<td>Total projected hours spent quarterly on all manual tasks by category, using the calculated duration of each task and the calculated volume of each task per month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Expense and Savings</td>
</tr>
<tr>
<td></td>
<td>[run_rate_predicted_savings]</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Projected Quarterly Expense by Category (Uses Calculated Duration &amp; Volume)</td>
<td>Total projected quarterly expense for all manual tasks by category using the calculated duration of each task, the calculated volume of each task per month, and the cost from the labor rate card. Note: This report uses negative numbers to express an expense. Type: Bar chart Table: Expense and Savings [run_rate_predicted_savings]</td>
</tr>
<tr>
<td>Projected Hours Spent Annually by Category (Uses Calculated Duration &amp; Volume)</td>
<td>Total projected hours spent annually on all manual tasks by category, using the calculated duration of each task and the calculated volume of each task per month. Type: Bar chart Table: Expense and Savings [run_rate_predicted_savings]</td>
</tr>
<tr>
<td>Projected Annual Expense by Category (Uses Calculated Duration &amp; Volume)</td>
<td>Total projected annual expense for all manual tasks by category using the calculated duration of each task, the calculated volume of each task per month, and the cost from the labor rate card. Note: This report uses negative numbers to express an expense. Type: Bar chart Table: Expense and Savings [run_rate_predicted_savings]</td>
</tr>
</tbody>
</table>

Schedule Orchestration ROI calculations for standard reports
The scheduled job that calculates Orchestration ROI standard reports is active by default and controlled by system properties.

Role required: orchestration_manager, admin

The system provides a default scheduled job called Processing ROI Schedule that allows you to configure when Orchestration calculates the ROI for standard reports. This schedule allows scripting for advanced conditions. To modify the schedule or write a script to run, open Processing ROI Schedule from System Scheduler > Scheduled Jobs > Scheduled Jobs and click Configure Job Definition. To execute the schedule directly from the job definition, click Execute Now

To control the running of the schedule job with the Orchestration properties.

1. Navigate to Orchestration ROI > Properties.
2. Configure the following properties:

**ROI schedule properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>roi.processing.active</td>
<td>Activate scheduled job for ROI processing. This property activates the Processing ROI Schedule scheduled job.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default</strong>: true</td>
</tr>
<tr>
<td>roi.processing.interval</td>
<td>Scheduled ROI processing interval (hours). This property sets the repeat interval for the scheduled job that processes savings reports and correlated tasks.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default</strong>: 24</td>
</tr>
</tbody>
</table>

3. Click **Save** to save your changes.

**Orchestration ROI premium reports**

The premium dashboard provides detailed reports on calculated savings over time.

The ROI premium reports require the Orchestration - ROI Premium plugin and are built using Performance Analytics. The Orchestration - ROI Premium plugin is dependent on the Performance Analytics - Premium plugin which requires a separate subscription.

**Important:** You must activate the Performance Analytics scheduled collection job before Orchestration ROI premium can display data.

To access the ROI premium dashboard, navigate to **Orchestration > ROI Reports > Premium Dashboard**.

**ROI By Category tab**

The ROI By Category tab contains three reports showing the calculated savings over time by category.
Calculated savings monthly by category

Premium reports for calculated savings over time by category

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROI - Monthly By Category</td>
<td>Shows the calculated savings each month by category. The chart displays the total calculated savings against the calculated savings for each category.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Column chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Detailed Savings Report</td>
</tr>
<tr>
<td>[detailed_savings_report]</td>
<td></td>
</tr>
<tr>
<td>ROI - By Category</td>
<td>Shows the trend of calculated savings by category.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Spline chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Detailed Savings Report</td>
</tr>
<tr>
<td>[detailed_savings_report]</td>
<td></td>
</tr>
<tr>
<td>ROI - Running Sum 12 month period</td>
<td>Shows the running sum of calculated savings for all categories in the last 12 months.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Area chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Detailed Savings Report</td>
</tr>
<tr>
<td>[detailed_savings_report]</td>
<td></td>
</tr>
</tbody>
</table>
ROI By Automation Entry

The ROI By Automation Entry tab contains two reports showing the calculated savings over time by automation entry.

Calculated savings for the current month by automation entry

Calculated savings over time by automation entry

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROI By Automation Entry</td>
<td>Shows the current month’s calculated savings for each automation entry.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Column</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Detailed Savings Report [detailed_savings_report]</td>
</tr>
<tr>
<td>ROI - By Automation Entry Top 10 List</td>
<td>Shows the top 10 automation entries that have the most calculated savings in the current month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Scorecard</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Detailed Savings Report [detailed_savings_report]</td>
</tr>
</tbody>
</table>

Request Orchestration ROI premium reports

To view the Orchestration ROI premium reports, you must request activation of the Orchestration - ROI Premium (com.snc.runbook_automation.roi_premium) plugin. The Orchestration - ROI Premium plugin is included with an Orchestration subscription, but must be activated by request.
The Orchestration - ROI Premium plugin requires the Performance Analytics - Premium plugin, which must be purchased separately.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.

4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Note: Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.</td>
<td></td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

Schedule Orchestration ROI calculations for premium reports

Orchestration ROI premium reports use a Performance Analytics job that must be activated before premium reports can be generated.

Role required: orchestration_manager, admin

The scheduled job required to calculate premium ROI reports is called [PA ROI] Historic Data Collection and is installed with the Orchestration - ROI Premium [com.snc.runbook_automation.roi_premium] plugin. This job is not active by default.

1. Navigate to **Performance Analytics > Data Collector > Jobs**.
2. Search for the [PA ROI] Historic Data Collection job.
3. Select the **Active** check box.
4. The scheduling options appear for the value selected in the **Run** field.
   For instructions on creating a schedule, see #unique_2238.
5. To execute the schedule directly from the job definition, click **Execute Now**.
6. Click **Update**.

**Client Software Distribution**

The Client Software Distribution (CSD) application allows administrators to distribute software from the service catalog using third-party management systems.

CSD allows an administrator to create all the records necessary to deploy software from service catalog requests, including software models and catalog items. You can use the CSD application to automate the deployment and revocation of software from an SCCM host using the custom **SCCM activity pack**. You can define lease periods for software distributed from the Service Catalog and allow lease extensions in some cases, pending approvals. Deployment is accomplished using Orchestration activities and workflows.

CSD also integrates with **Software Asset Management** to manage license counts for deployed software.
CSD process flow using SCCM

Request client software distribution

Client software distribution requires the Orchestration - Client Software Distribution plugin (com.snc.orchestration.client_sf_distribution), which is available by request with a subscription to Orchestration.

Role required: admin
The Orchestration - Client Software Distribution plugin activates the Orchestration - System Center Configuration Manager plugin that contains the custom SCCM activities used to deploy or revoke software using an SCCM server. For additional plugin dependencies, see Plugins installed with client software distribution.

**Note:** The Orchestration - Client Software Distribution plugin runs in its own application scope.

1. Navigate to **System Applications > All Available Applications > All.**
2. On the All Applications page, click **Request Plugin** to open the request form on HI.

![Request Plugin](https://example.com/request-plugin)
3. On HI, select to be redirected to the HI Service Portal Service Catalog.

<table>
<thead>
<tr>
<th>Activate Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>In order to enhance the user experience, we have redesigned Activate a Plugin service catalog. Please use the new HI Service Portal 'Activate a Plugin' service catalog item. You can also use Manage Instances page on Service Portal to Activate a Plugin.</td>
</tr>
<tr>
<td>Take me to the HI Service Portal Activate a Plugin Service Catalog.</td>
</tr>
</tbody>
</table>

4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments.</td>
</tr>
</tbody>
</table>

5. Click Submit.

**Installed with client software distribution**

Several types of components are installed with client software distribution (CSD).

*Tables installed with client software distribution*

These tables are installed with the Orchestration - Client Software Distribution plugin (com.snc.orchestration.client_sf_distribution).

**Client software distribution tables**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Software Distribution Catalog Item</td>
<td>Contains all catalog items created for client software distribution. This table extends the Catalog Item [sc_cat_item] table.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Client Software Distribution Software Request [sn_client_sf_dist_req_software]</td>
<td>Contains all requested software, and their statuses.</td>
</tr>
<tr>
<td>Client Software Distribution Application [sn_client_sf_dist_application]</td>
<td>Contains all discovered CSD applications.</td>
</tr>
<tr>
<td>Client Software Distribution Provider [sn_client_sf_dist_provider]</td>
<td>Contains all software distribution providers.</td>
</tr>
<tr>
<td>Client Software Distribution Extension Key [sn_client_sf_dist_extension_key]</td>
<td>Contains the predefined CSD extension keys.</td>
</tr>
<tr>
<td>Client Software Distribution Extension Point [sn_client_sf_dist_extension_point]</td>
<td>Contains the customization script for the extension keys.</td>
</tr>
<tr>
<td>Client Software Distribution Software Configuration [sn_client_sf_dist_software_config]</td>
<td>Base table for all software provider configurations.</td>
</tr>
<tr>
<td>SCCM Server Instance [sn_client_sf_dist_cmdb_ci_sccm_server]</td>
<td>Contains all SCCM server instances. This table extends the Configuration Item [cmdb_ci] table.</td>
</tr>
<tr>
<td>SCCM Application [sn_client_sf_dist_sccm_application]</td>
<td>Contains all discovered SCCM applications. This table extends the Client Software Distribution Application [sn_client_sf_dist_application] table.</td>
</tr>
<tr>
<td>SCCM Application Catalog Item [sn_client_sf_dist_sccm_app_cat_item]</td>
<td>Contains all catalog items created for SCCM applications. This table extends the Client Software Distribution Catalog Item [sn_client_sf_dist_cat_item] table.</td>
</tr>
<tr>
<td>SCCM Collection [sn_client_sf_dist_sccm_collection]</td>
<td>Contains all discovered SCCM collections. Contains all discovered SCCM collections.</td>
</tr>
<tr>
<td>SCCM Deployment [sn_client_sf_dist_sccm_deployment]</td>
<td>Contains all discovered SCCM deployments. Contains all discovered SCCM deployments.</td>
</tr>
<tr>
<td>SCCM Configuration [sn_client_sf_dist_sccm_config]</td>
<td>Contains the SCCM application, install and uninstall collections, and Discovery model. This table extends the Client Software Distribution Software Configuration [sn_client_sf_dist_software_config] table.</td>
</tr>
</tbody>
</table>

**Plugins installed with client software distribution**

These plugins are installed with the Orchestration - Client Software Distribution plugin, if they are not already active.

For instructions on requesting activation of Client Software Distribution (CSD) see [Request client software distribution](#).

**Plugins for Orchestration - Client Software Distribution**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orchestration - System Center Configuration Manager [com.snc.orchestration.sccm_mgnt]</td>
<td>Installs the custom SCCM Orchestration activities that do work on the SCCM target host.</td>
</tr>
<tr>
<td>Orchestration - Asset Lease Management [com.snc.orchestration.asset_lease_management]</td>
<td>Installs the lease functionality for software distributed through the Service Catalog. This includes starting, stopping, and extending leases.</td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Service Catalog Scoped API [com.glideapp.servicecatalog.scoped.api]</td>
<td>Installs the API to support application creation in the Service Catalog.</td>
</tr>
<tr>
<td>Software Asset Management [com.snc.software_asset_management]</td>
<td>Provides the ability to manage software assets, including the reconciliation of entitlements to licenses for named users, workstation, and enterprise software agreements.</td>
</tr>
</tbody>
</table>

**Roles installed with client software distribution**
These roles are installed with the Orchestration - Client Software Distribution plugin.

**Roles for Orchestration - Client Software Distribution**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
</table>
| Client software distribution admin [sn_client_sf_dist.csd_admin] | Administrator role for managing client software distribution application. | • sam
 • agent_admin
 • report_admin
 • catalog_admin
 • itil
 • workflow_admin |

**Script includes installed with client software distribution**
These script includes are installed with the Orchestration - Client Software Distribution plugin.

**Script includes for Orchestration - Client Software Distribution**

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSDExtensionPoint</td>
<td>Execute the CSD provider’s specific code</td>
</tr>
<tr>
<td>CSDUtil</td>
<td>Utility functions for the CSD application.</td>
</tr>
<tr>
<td>RefQualsCSD</td>
<td>Reference qualifier filter. This script provides the filter functions for the CSD providers, devices, SCCM application, install collections, and uninstall collections.</td>
</tr>
<tr>
<td>SCCMCatItemHandler</td>
<td>Sets the field values of specific SCCM catalog items. These values are the SCCM catalog item table name, catalog item name, SCCM provider, and SCCM software configuration.</td>
</tr>
<tr>
<td>SoftwareCatItemCreator</td>
<td>Creates software catalog items</td>
</tr>
<tr>
<td>CSDCatItemHandler</td>
<td>Base class for CSD catalog item creation. This script is used by the Create Catalog Item UI action to create and application catalog.</td>
</tr>
<tr>
<td>CSDDemoDataUtil</td>
<td>Populates demo data.</td>
</tr>
<tr>
<td>CSDDemoDataUtilAjax</td>
<td>Populates demo data.</td>
</tr>
</tbody>
</table>
Properties installed with client software distribution
Properties for client software distribution (CSD) manage the installation status of requested software deployments and configure scheduled Discoveries.

To access CSD properties, navigate to **Client Software Distribution > Properties**. The following properties are available:

### Client software distribution properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Status check expiration interval (days) | sn_client_sf_dist.softwareInstallExpDays | Controls how many days the system waits before ignoring the software installation status. The default time limit for installing software is 30 days before the system stops checking the installation status of a deployment. Installation statuses are:  
  - **Not installed**: User has not installed requested software prior to the expiration of the configured time limit.  
  - **Installed**: Software was installed within the configured time limit.  
  - **Status check expired**: Time limit has expired for the user to install the requested software. The system no longer checks the status of this deployment.  
  - **Revoked**: Software was revoked by the administrator.  
  - **Type**: integer  
  - **Default value**: 30 |
| Reconcile software installation status interval (hours) | sn_client_sf_dist.softwareInstallIntervalHour | Determines when the scheduled job runs that determines the installation status. By default, the system checks the installation status every hour.  
  - **Type**: integer  
  - **Default value**: 24 |
| Set scheduled application Discovery interval (days) | sn_client_sf_dist.discoveryExeDay | Sets the repeat interval for the scheduled job that runs application Discovery. By default, Discovery runs at midnight on the day set with this value.  
  - **Type**: integer  
  - **Default value**: 5 |
<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Set lease execution schedule job interval (minutes)                     | sn_client_sf_dist.lease_execution_interval | Interval in which the CSD Lease Schedule scheduled job checks for requested software leases to start, stop, or extend.                                                                                           - Type: integer  
- Default value: 1                                                                                                                                                           |
| Set time prior to lease end to notify requester (days)                  | sn_client_sf_dist.lease_end_notification | Determines how many days prior to the end of a software lease to notify the requester. If lease extensions are allowed, ensure that this period provides enough time for the approval process to complete before the lease expires.                                                                                                                                                      - Type: integer  
- Default value: 5                                                                                                                                                                                                                     |

*Workflows installed with client software distribution*

These workflows are installed with the Orchestration - Client Software Distribution plugin

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discover SCCM</td>
<td>Retrieves lists of applications, collections, and deployments from SCCM servers using custom CSD orchestration activities. An administrator runs this workflow from a UI action in a SCCM Server Instance record.</td>
</tr>
<tr>
<td>Order Client Software</td>
<td>Runs automatically when a user orders software from the service catalog.</td>
</tr>
<tr>
<td>Deploy SCCM Application</td>
<td>Triggered by the Order Client Software workflow to deploy software through SCCM server. This workflow adds either the user or the device into the SCCM collection.</td>
</tr>
<tr>
<td>Revoke Client Software</td>
<td>Begins the software revocation process for software deployed by an external provider. Administrators run this workflow from a UI action on the Requested Software record and the Installed Software Not Entitled record. This workflow triggers the appropriate provider workflow that performs the actual revocation. For example, this workflow triggers the Revoke SCCM Application workflow for applications in SCCM uninstall collections.</td>
</tr>
</tbody>
</table>
Create licenses and counters for distributed software

Licenses and software counters are associated with the software model and must be created if you want to track the license for software deployed by client software distribution (CSD).

Role required: sam or admin

You can create software licenses and counters in Software Asset Management for software items deployed from the service catalog by CSD. CSD depends on the software counter result to determine if the license is available for the requested software. If the license Valuation is greater than 0, and the license type is Not allocated, CSD assumes that the license is available for the software.

1. Navigate to Software Asset > Software Licenses.
2. Add a new software license for the software model you used in CSD.
3. Navigate to Software Asset > Reconciliation > Software Counters.
4. Create a software counter for the software model you created.
5. Run the counter to retrieve the software license information.

Client software distribution ordering process

Software deployed by Client Software Distribution (CSD) can be ordered from the service catalog by individual users or by approved users on behalf of others.

Client Software Distribution catalog items have different options, depending on how ordering is configured.

Lease start and end dates

All software deployed by CSD requires users to specify the beginning date for the lease. This is enforced by the Orchestration - Asset Lease Management plugin that is activated automatically with CSD. The system prepopulates the Lease start field with the current date and time.

If the catalog item is configured for revocation (uninstall), the form displays the Lease end field, which allows the requester to define an end date and time for the lease. The system validates user input in these fields to ensure that the dates selected define a future window. The Lease end field is not mandatory and can be left blank to order software with no end date.

Note: For systems deploying software from Microsoft System Center Configuration Management (SCCM), the Lease end field is only available if the SCCM configuration specifies an uninstall collection.

Software offered only to the logged in user

If the software catalog item is configured with the Order on behalf of check box cleared, the User field does not appear on the order form. The logged in user selects the device on which to deploy the software from the Device to install this software on field. Only those devices assigned to the logged in user appear in the list.
In this example, a user has logged into the service catalog to order Firefox for a computer that is assigned to her. She selects the machine from a list of devices she owns and selects the date and time the lease should begin. This software is deployed through Microsoft System Center Configuration Management (SCCM), but does not have an uninstall collection configured and cannot be revoked automatically by the system. As a result, the **Lease end** field is not available.

### Ordering software as the logged in user

### Software ordered on behalf of another user

If the software catalog item is configured with the **Order on behalf of** check box selected, the **User** field appears on the form. The logged in user can select any user from this field. The **Device to install this software on** field only lists the devices assigned to the user selected in the **User** field. If an approval is required for software ordered on behalf of another user, the system automatically sends an approval request to the manager of the user receiving the software. The approval is skipped if the requester is the named user’s manager.
In this example, a manager is ordering Google Chrome for a contractor. The manager selects the contractor from the **User** field and then chooses a computer from the list of devices assigned to the contractor. This software has an SCCM uninstall collection configured, which allows the manager to select an end date for the lease that coincides with the end of the user's contract. When the lease expires, SCCM automatically uninstalls the software from the device.

**Defining software lease window**

**Extend a software lease**

Users of software deployed by Client Software Distribution (CSD) can request the extension of a lease window, if the software is revocable by a software distribution system.

Role required: Any system user

If your software has a lease end date defined, and the software status is **Installed**, you can request an extension of the lease, pending any approvals your organization requires.

1. Navigate to **Service Catalog > My Requested Software**.
   
   The list shows only the software you have requested from the service catalog.

2. Select the record for the installed software whose lease you want to extend.
3. Under **Related Links** click **Extend Lease**.

   ![Requested Software form](image)

   **Related Links**
   - Extend Lease
   - Revoke Software

4. In the dialog box that appears, select a new lease end date in the calendar and click **OK**. You must select a date later than the current date.

   ![New Lease End Date Time](image)

   If the lease extension is subject to manager approval, you are notified of the decision. If the request is approved, a notification shows the new lease end date. If the new end date is within 5 days (the default notification period) of the date when you made the request, CSD sends an immediate end-of-lease notification.

   **Important:** If lease extensions in your organization require approval, make sure the approver is available and has enough time to process your extension request. If the extension cannot be approved before the original end date expires, the software is revoked.
**Client software distribution from SCCM**

You can use Client Software Distribution (CSD) to deploy and revoke software deployments from Microsoft System Center Configuration Management (SCCM) and manage distributions on SCCM hosts.

The SCCM activity pack contains Orchestration activities that CSD uses to deploy software from a service catalog request and manage user and device collections on SCCM servers. In addition, CSD can manage license counts for deployed software using ServiceNow Software Asset Management, revoke software deployed by SCCM without user interaction, and manage lease periods.

**Configuring SCCM**

Follow the SCCM configuration procedures in the order shown.

Configure the Application Administrator role on the SCCM server

To deploy software using ServiceNow® Client Software Distribution (CSD), ensure that an SCCM administrative user has the correct permissions to deploy software and that PowerShell is properly configured.

SCCM role required: Application Administrator

These instructions are for Microsoft 2012 R2 Server.

1. In the System Center Configuration Manager console, navigate to Administration > Security > Administrative Users.
2. Right-click the user to whom you want to grant the Application Administrator role.
3. Select Properties from the drop-down menu.
4. In the Properties dialog box, select the Security Roles tab.
5. Ensure that the user has the Application Administrator role.
6. If the user does not already have this role, click **Add**, select this role from the list, and click **OK**.
Granting the Application Administrator role on the SCCM server
7. Log into SCCM as the user with the Application Administrator role.
8. Open the menu from the upper left corner of the console and select Connect via Windows PowerShell.

Connect to PowerShell

9. Ensure that the user can access the CM console.
   This action establishes the environment path to PowerShell for the logged in Application Administrator user.

Update the SCCM cmdlet libraries
Ensure that the System Center Configuration Manager SCCM Cmdlet Library is up-to-date.
SCCM role required: Either current user or system administrator, depending on settings.
The System Center Configuration Manager SCCM Cmdlet Library installs and updates the Windows PowerShell module for SCCM. SCCM checks for library updates on a daily basis. Out-of-date libraries can cause Discovery of the SCCM server to fail, because the system cannot parse the SCCM activity output. This warning message appears in the ECC queue input records for the SCCM GET activities:

WARNING: An update to the System Center 2012 Configuration Manager Cmdlet Library is available. Please go to 'http://go.microsoft.com/fwlink/?LinkId=528947' to download the latest version.
Running cmdlet version: 5.0.8231.1004 Latest cmdlet version: 5.0.8328.1155

If you elect to use an earlier version library, use this procedure to disable the CM update check, which allows Discovery to proceed without issues.

1. Log into the SCCM console as an administrator.
2. Open the menu from the upper left corner of the console.
3. Select **Connect via Windows PowerShell**.
4. Run one of these commands to disable the update check:
   - **Per-user**: `Set-CMCmdletUpdateCheck -CurrentUser -IsUpdateCheckEnabled 0`
   - **Per-system**: `Set-CMCmdletUpdateCheck -System -IsUpdateCheckEnabled 0`

   **Important**: The per-system cmdlet must run in an elevated Windows PowerShell session.

5. Run the `Get-CMCmdletUpdateCheck` command to refresh the console and check the settings.
6. Ensure that the value of the `IsEnabled` configuration variable has changed to `False`.
   This indicates that the warning for an out of date cmdlet library is disabled for the users specified.
7. To re-enable the update check, run the `-IsUpdateCheckEnabled 1` command for either the current user or the system.

Configure the MID Server for SCCM activities

To use a MID Server with Microsoft System Center Configuration Management (SCCM) activities, configure it to communicate with the SCCM server.

Role required: admin

1. In the navigation filter, enter `cmdb_ci_dns_name.list`.
2. Click **New**.
3. Enter the fully-qualified domain name (FQDN) of the SCCM server in the **Name** field.
4. Right-click in the form header and select **Save**.
5. In the **IP Address** related list, click **New**.
6. In the **IP Address** field, enter the IP address of the SCCM server.
7. In the **Nic** field, select `eth0` or your preferred network interface controller.
8. Leave the **Netmask** field blank.
9. Click **Submit**.

Create Windows credentials for SCCM deployments

Microsoft System Center Configuration Manager (SCCM) requires the appropriate credentials to deploy applications using the Client Software Distribution application.

Role required: `sn_client_sf_dist.csd_admin` or admin

Client software distribution requires Windows credentials that have administrative rights on the SCCM server.

1. Navigate to **Orchestraton > Credentials**.
2. Click **New**.
3. In the list of credential types, select **Windows Credentials**.
4. Provide a user name and password with administrative rights on the SCCM server.

   **Important**: Ensure the following:
   - This user must have the Application Administrator role on the SCCM server.
5. Fill in the other fields on the form, as appropriate.
   For details, see Windows credentials.
6. Click Submit.

Retrieve SCCM data for client software distribution
Retrieve the collections and the list of applications available for deployment from your SCCM servers.

**Role required:** sn_client_sf_dist.csd_admin or admin

Before starting this procedure:

- Set up your Microsoft System Center Configuration Manager (SCCM) server, create the applications and collections, and configure the deployments you need. For information, see your SCCM documentation.
- **Configure a user** with the Application Deployment Manager role on the SCCM server.
- Set up the MID Server to communicate with the SCCM server.
- Add PowerShell credentials to the ServiceNow Credentials [discovery_credentials] table for the SCCM user who has the Application Deployment Manager role.

To populate the Client Software Distribution application with SCCM data:

1. Navigate to **Client Software Distribution > SCCM > SCCM Server Instance**.
2. Click New.
3. In the SCCM Server Instance form, identify the server by name and provide the fully qualified domain name.
4. Click Submit.
   The new SCCM server appears in the list.
5. Open the new SCCM record and click **Discover now** under **Related links**.

The system runs the Discover SCCM workflow that retrieves the application, collection, and deployment data from the SCCM server.

### SCCM server Discovery for client software distribution

A Discovery workflow populates ServiceNow tables with collection, application, and deployment data retrieved from SCCM servers.

Users run the **Discover SCCM** workflow from an **SCCM Server Instance record** to populate the following ServiceNow tables:

#### SCCM data populated in ServiceNow tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Fields</th>
</tr>
</thead>
</table>
| SCCM Application [sn_client_sf_dist_sccm_application] | • name  
• publisher  
• version  
• model  
• sccm_server |
| SCCM Collection [sn_client_sf_dist_sccm_collection] | • name  
• type  
• sccm_server |
### SCCM Deployment

**Fields**
- application
- collection
- type

---

**Note:** For details about the custom activities used in this workflow to extract data from an SCCM server, see Orchestration SCCM activity pack.

Set up a software model for an SCCM application

Using the applications discovered on the SCCM server, set up a software model used by the Software Asset Management application to manage licenses.

Role required: sn_client_sf_dist.csd_admin or admin

Before creating software models, you must discover the applications available for deployment on the SCCM server. See Retrieve SCCM data for client software distribution for details.

You can link an SCCM application to an existing software model or create a new model.

1. Navigate to **Client Software Distribution > SCCM > SCCM Applications**.
   A list of applications discovered on the SCCM server appears.
2. Open an SCCM application record.
3. To link to an existing model, click the magnifying glass icon in the **Model** field and select a model from the list.

---

**SCCM Application record**
4. To create a model, click **Create Software Model** under **Related Links**.
   a) Complete the software model fields.
      See for details.
   b) Click **Submit**.
      The view returns to the SCCM Applications form.

Define an SCCM configuration

To create catalog items for SCCM software deployment or to configure your instance to revoke software through SCCM, you must first associate that software with a collection through an SCCM configuration.

Before you create an SCCM configuration record, make sure you have discovered the SCCM applications, collections, and deployments and set up the necessary software models.

Role required: sn_client_sf_dist.csd_admin or admin

The SCCM configuration process associates software with SCCM collections. To deploy software from an SCCM server, the user or device must be a member of an SCCM collection associated with an **install** deployment. Client Software Distribution (CSD) allows you to **revoke unentitled software** using an SCCM server when that software can be removed using an **uninstall** collection. Users requesting revokable software from the Service Catalog also have the ability to define lease start and stop dates and request lease extensions.
SCCM table references

1. Navigate to **Client Software Distribution > SCCM > SCCM Applications**.
2. Open an application that has a configured software model.
3. Under **Related Links**, click **Create Software Configuration**.
4. Complete the form, using the fields in the table.

**SCCM configuration form**

**SCCM configuration fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Recognizable name for this SCCM software configuration.</td>
</tr>
<tr>
<td>SCCM application</td>
<td>Name of an application hosted on the SCCM server.</td>
</tr>
<tr>
<td>SCCM collection</td>
<td>Name of the collection associated with the <strong>install</strong> deployment for the selected application on the SCCM server. Only those collections associated with the application are available for selection.</td>
</tr>
</tbody>
</table>
| SCCM uninstall collection | Name of the collection associated with the **uninstall** deployment for the selected application on the SCCM server. You must specify an uninstall collection to:  
  - Define a lease end date for deployed software.  
  - Allow lease extensions.  
  - Revoke software from a user's machine. |
Create a catalog item for an SCCM application

Using the applications discovered on the SCCM server, create a catalog item for an application you want to offer for distribution from the service catalog.

Role required: sn_client_sf_dist.csd_admin or admin

Before creating a catalog item, you must link the application to a software model and create at least one software configuration.

1. Navigate to **Client Software Distribution > SCCM > SCCM Applications**.
   
   A list of applications discovered on the SCCM server appears.

2. Open a record for an SCCM application.

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery model</td>
<td>Discovery model that links the unentitled software installation with the SCCM configuration. From the SCCM configuration record, Client Software Distribution can determine which collection to use to revoke the software. Unentitled software is software found on the user's machine that the user is not entitled to use.</td>
</tr>
</tbody>
</table>
3. Under **Related Links**, click **Create Catalog Item**.
   A new SCCM Application Catalog Item record appears with preconfigured information.
4. Add price information and complete the following fields added to the Client Software Distribution Catalog Item [sn_client_sf_dist_cat_item] table by the Orchestration - Client Software Distribution plugin:

**SCCM fields in the catalog item form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skip approval (skip_approval)</td>
<td>Check box that allows skipping approval for this item by the requester's manager when a user orders it from the service catalog. Use this field in conjunction with the <strong>Order on behalf of</strong> field to ensure that software ordered by a logged in user on behalf of another user is subject to approval. By default, this check box is cleared, requiring manager approval for all new catalog items.</td>
</tr>
<tr>
<td>Check license compliance (check_license_compliance)</td>
<td>Check box that forces the system to determine if deploying this item is allowed under the current license.</td>
</tr>
</tbody>
</table>
| Order on behalf of                         | Check box that allows the logged-in user to order this software from the service catalog for another user. This permits service desk personnel to order SCCM deployments for other users in the system. By default, this feature is enabled. To prevent unauthorized users from ordering software, ensure that approvals are required for this type of deployment by clearing the **Skip approval** check box.  

If an approval is required for software ordered on behalf of a user, the system automatically sends an approval request to the manager of the user receiving the software. The approval is skipped if the requestor is the named user's manager. 
Software items requested from the service catalog on behalf of a different user require the following information:

- **User**: User selected for deployment. This field is automatically populated with the name of the logged in user. You can select another user from the list.
- **Device to install this software on**: Device belonging to the selected user on which to deploy the software. Only devices belonging to that user appear in the choice list.
- **Lease start**: Date and time to deploy the software. This is the start time for the lease. A lease can be open-ended or have a lease end time.  |
### Field Description

| SCCM configuration | Name of the **SCCM configuration record** for this application. This record defines the collection and uninstall collection for this application. This configuration is required for all deployments, revocations, and leases performed by the SCCM server. |

5. If the catalog item requires approval because of cost, be sure to configure an approval group in the **Approved By Group** related list.

By default, the Service Catalog Request workflow runs when an item costing more than $1000 is ordered and looks for an appropriate approval group. If no approval group is configured for the item, this workflow skips approval altogether and ends. The system then runs the Order Client Software workflow, which evaluates the **Skip approval** check box to determine if approval by the requester's manager is required.

6. **Click Update.**

The view returns to the SCCM Applications list.

7. **To see all client software distribution (CSD) catalog items, navigate to Client Software Distribution > Maintain Items > Software Items.**

### Workflow process for SCCM deployment

Ordering an SCCM application from a client software distribution (CSD) catalog item in the service catalog triggers the Order Client Software workflow.

This process deploys an SCCM application to a user or device through a service catalog order:

1. If the **Skip approval** check box is cleared in the software catalog item, the Order Client Software workflow sends the catalog request to the requesting user's manager for approval.

2. If the **Check license compliance** check box is selected in the software catalog item, the workflow performs a software license check. If there is no license available, the workflow creates a catalog task to procure more licenses and assigns the task to the Client Software Distribution Administrators group.

3. The Order Client Software workflow triggers the Deploy SCCM Application workflow as a subflow. This workflow adds either the user or the device to the SCCM collection using the **Add to User Collection** or **Add to Device Collection** SCCM activity.

4. If the software configuration specifies **SCCM uninstall collection** in the software catalog item, the Deploy SCCM Application workflow checks if the user or device exists in the uninstall collection. The workflow uses the **Is Device in Collection** or **Is User in Collection** SCCM activity. If the user or device exists in the uninstall collection, the workflow removes the device or user. The workflow uses the **Remove from Device Collection** or **Remove from User Collection** SCCM activity before adding it to the **SCCM install collection**.

### Client software distribution validation process

After SCCM deploys software to a target computer, client software distribution (CSD) detects the installation and validates its status.

Client software distribution uses the following methods for detecting software installed on the target machine:

- **Discovery**: CSD is configured to leverage Discovery to detect software installations. You can run Discovery manually at any time, or by a scheduled job.

- **Microsoft SCCM Integration**: You can import SCCM data into the CMDB using the features in the Integration - Microsoft SCCM plugin if Discovery is not active on the instance.

The instance uses the data gathered by Discovery or the SCCM integration plugin to populate the Software Installation [cmdb_sam_sw_install] table. To validate installations using this data, CSD runs a scheduled...
job called Reconcile Requested Software that uses CSD property settings. This process reconciles the software installation data accumulated in the CMDB and makes these status updates:

- **Not installed** to **Installed**: The user has installed the requested software within the time limit configured in the `sn_client_sf_dist.softwareInstallExpDays` property.
- **Not installed** to **Status check expired**: The time limit has expired for the user to install the requested software. The system stops checking for installation when the time limit expires.

**SCCM software revocation**
An administrator can revoke software without any user interaction using Microsoft System Center Configuration Manager (SCCM) if the software configuration specifies an SCCM uninstall collection, even if the software was installed by some other process or user.

Revoke software deployed through the service catalog
Software deployed by SCCM can be revoked, but only when the software's status is **Installed** and the application associated with the software configuration has an uninstall collection configured.

- Create an **SCCM configuration record** for the application that names an appropriate uninstall collection.
- Associate the **CSD catalog item** for the application with the SCCM configuration that specifies the uninstall collection.

Role required: `sn_client_sf_dist.csd_admin` or admin

A workflow called **Revoke SCCM Application** moves either the user or the device from its respective collection and adds it to the appropriate uninstall collection. When SCCM performs an internal policy check and finds the user or device in the uninstall collection, SCCM removes the related software package from the client computer.

1. Navigate to **Client Software Distribution > Reports > Requested Software**.
2. Open the record for the SCCM software package you want to revoke.
   - The package must have a **Status** of **Installed** to be revocable.
3. Under **Related Links**, click **Revoke software**.
   - This action runs the Revoke Client Software workflow, which triggers the Revoke SCCM Application subflow that moves the user or device from the install collection to the uninstall collection. When SCCM performs an internal policy check and finds the user or device in the uninstall collection, SCCM removes the related software package from the client computer.

Revoke unentitled software
An administrator can revoke software using Microsoft System Center Configuration Manager (SCCM) that a user is not entitled to use even if the software was installed by some other process or user.

To revoke software using SCCM, you must create an **SCCM configuration record** for the application, in which the appropriate software Discovery model is defined. See **Software discovery models**.

Role required: `sn_client_sf_dist.csd_admin` or admin

Client Software Distribution (CSD) uses **Software Asset Management** to identify unentitled software installations. Discovery detects the software on the user's machine, and SAM determines if the user or device is entitled to use that software. This might include software that was not installed through a catalog request or software that the user installed without approval. If the software installation's Discovery model is associated with an SCCM software configuration that has an uninstall collection defined, then an administrator can use CSD to revoke that software from the user's machine without involving the user.

1. Navigate to **Client Software Distribution > Reports > Installed Software Not Entitled**.
2. Select the record for the installation that has unentitled users.
3. Under **Related Links**, click **Revoke software**.
   - This action runs the Revoke Client Software workflow, which triggers the Revoke SCCM Application subflow that moves the user or device from the install collection to the uninstall collection. When...
SCCM performs an internal policy check and finds the user or device in the uninstall collection, SCCM removes the related software package from the client computer.

Revoking a software installation

SCCM software revocation workflow

The Revoke SCCM Application workflow moves a user or device from an install collection to an uninstall collection to revoke software installed from Microsoft System Center Configuration Manager (SCCM).
For the revocation workflow to run, the software package must have a status of **Installed** and must be pre-configured for an appropriate uninstall collection. See Revoke software deployed through the service catalog for configuration instructions. When an administrator initiates the revocation process, the system launches the Revoke SCCM Application workflow to move the user or device collection associated with installation to the appropriate SCCM uninstall collection. When the SCCM server performs a policy check, it finds the additions to the user or device uninstall collection and revokes the software package associated with that collection.

The workflow employs two custom activities, Remove from User Collection and Remove from Device Collection, to remove either the user or the device from its original collection. The workflow then adds the user or device to the appropriate uninstall collection on the SCCM server with the Add to User Collection or Add to Device Collection activity.

**Note:** This workflow is triggered by the Revoke Client Software workflow as a subflow.

### Client software distribution dashboard

The CSD dashboard provides a collection of visual reports for the Client Software Distribution application.

To access the CSD dashboard, navigate to **Client Software Distribution > Requested Software > Dashboard**.

![Sample report from CSD dashboard](image)

### Client software distribution reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Tasks</td>
<td>Displays all open tasks grouped by the requested item's stage value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> List reports</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Catalog Task [sc_task]</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Top 10 Applications Installed</td>
<td>Displays the top 10 applications installed by request count.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Bar chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
<tr>
<td>Total Software Request Item Over Time</td>
<td>Displays the total software items requested each month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Line chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
<tr>
<td>Requests Completed Report</td>
<td>Displays the total of software requests completed each month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Line chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
<tr>
<td>Installed Software Not Entitled</td>
<td>Displays installed software that users or devices are not entitled to use.</td>
</tr>
<tr>
<td></td>
<td>This can be software deployed through CSD or by another process that does</td>
</tr>
<tr>
<td></td>
<td>not comply with licensing. This report is on a Software Asset Management table.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> List reports</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Software Installation [cmdb_sam_sw_install]</td>
</tr>
<tr>
<td>Software Installation Status</td>
<td>Displays the count of requested software, grouped by installation status,</td>
</tr>
<tr>
<td></td>
<td>for each month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Line chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
<tr>
<td>Software Requested Item Stage Report</td>
<td>Displays the sum of all requested items, grouped by the requested item's</td>
</tr>
<tr>
<td></td>
<td>stage, for each month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Line chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Requested Software [sn_client_sf_dist_req_software]</td>
</tr>
<tr>
<td>License Counts Available</td>
<td>Displays the license counts for all available applications.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> List reports</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> SCCM Application Catalog Item [sn_client_sf_dist_sccm_app_cat_item]</td>
</tr>
</tbody>
</table>

**Client software distribution extension framework**

Client software distribution (CSD) provides built-in extension points for integrating a ServiceNow instance with client software distribution providers, such as Casper, Altiris, or LANDesk.
**Caution:** The use of CSD extension points is an advanced procedure intended for use by experienced Now Platform developers only. Instructions for customizing your instance to deploy and revoke software from a software distribution provider can be found in the CSD Extension Implementation Guide.

Configure client software distribution providers
Identify the provider and specify the workflows and extension points for a customized software distribution process.

Perform the development tasks described in the CSD Extension Implementation Guide before attempting this procedure.

Role required: sn_client_sf_dist.csd_admin, admin

1. Navigate to **Client Software Distribution > Extensions > Providers.**  
2. Click **New.**  
3. Complete the form using the fields in the table.

![Client Software Distribution Provider - Casper](image)

Provider information for Casper integration

Client software distribution provider fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the provider.</td>
</tr>
<tr>
<td>Provider server</td>
<td>Table name of the provider server. You must create this table as an extension of the Configuration Item [cmdb_ci] table. For example, you might call your table Casper Server Instance [cmdb_ci_casper_server_instance].</td>
</tr>
<tr>
<td>Discovery workflow</td>
<td>Workflow that discovers the provider server and returns the data from that server back to the instance. This is the workflow you create with custom activities that query the provider server.</td>
</tr>
<tr>
<td>Software configuration</td>
<td>Table name of the software configuration for this provider. You create this table as an extension of the Client Software Distribution Software Configuration [sn_client_sf_dist_software_config] table. For example, you might create a table called Casper Software Configuration [sn_client_sf_dist_casper_sf_config].</td>
</tr>
<tr>
<td>Deployment extension key</td>
<td>The <strong>SetDeploymentData</strong> key provided with CSD. This key sets up the data for the software ordering and deployment workflow.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deployment workflow</td>
<td>Workflow that deploys software from the provider server. This is the workflow you created with custom activities that tells the provider where to deploy an application requested from the service catalog.</td>
</tr>
<tr>
<td>Revocation extension key</td>
<td>The <strong>SetRevocationData</strong> key provided with CSD. This key sets up the data for installation revocation.</td>
</tr>
<tr>
<td>Revocation workflow</td>
<td>Workflow that revokes an installation from a provider server. This is the workflow you created with custom activities that tells the provider which application to remove from a device.</td>
</tr>
</tbody>
</table>

**Client software distribution extension keys**

Client software distribution (CSD) extension keys allow you to customize the deployment and revocation of software from distribution providers.

These pre-defined keys allow you to generate input variables for workflows that deploy and revoke software from external distribution providers:

- **SetDeploymentData**: Sets the software order information and generates the input variables for the deployment workflow.
- **SetRevocationData**: Generates the input variables for the revocation workflow.
- **CheckRevocable**: Specifies the conditions that determine if an installation can be revoked. If the software configuration associated with the installed software allows uninstallation, the installed software can be revoked.

**Client software distribution extension points**

The client software distribution (CSD) extension points create the customization code for the specific provider and the extension keys.

The purpose of the extension points is to associate extension keys with a specific provider, and then create a script that sets input variables for your custom deployment and revocation workflows. Another extension point script tells CSD if the provider has the capability to revoke software. If this is the case, CSD enables the UI action that triggers revocation from the provider.

**SetDeploymentData**

The script associated with this extension key must set the `csdExtensionResult` object with these attributes:

- **deploymentWorkflowInputs**: Object that specifies the deployment workflow input variables.
- **softwareModel**: Software model `sys_id`.
- **deploymentType**: An integer. Use 1 for deployment to a user and 2 for deployment to a device.
- **softwareApplication**: Software application `sys_id`.

**CheckRevocable**

The script associated with this extension key gets the input parameter `csdExtensionInputs.softwareConfiguration`, which is a Client Software Distribution record in the Software Configuration `[sn_client_sf_dist_software_config]` table. All providers' software configurations are extended from this table, but may have different attributes.
This script must set the **csdExtensionResult** object to **true** or **false**, depending on whether the software configuration specifies uninstallation.

### SetRevocationData

The script associated with this extension key gets the input parameter **csdExtensionInputs.softwareConfiguration**, which is a Client Software Distribution record in the Software Configuration [sn_client_sf_dist_software_config] table. All providers' software configurations are extended from this table, but may have different attributes.

The script must set the **csdExtensionResult** object with these attributes:

- **revocationWorkflowInput**: Object that specifies the revocation workflow input variables.
- **softwareModel**: Software model sys_id.
- **deploymentType**: An integer. Use 1 for deployment to a user and 2 for deployment to a device.

### Orchestration examples

These examples demonstrate how Orchestration can be used to automate common tasks.

#### Active Directory automation example

A set of six Orchestration Active Directory activities enables organizations to automate their on-boarding/off-boarding processes with auditable, self-documenting workflows that save time and eliminate mistakes.

The activities in the **Active Directory activity pack** are designed to manage user accounts and reset user passwords. The following activities cover the most common use cases administrators encounter when managing Active Directory user accounts:

- Create AD User Account
- Update AD User Account
- Remove AD User Account
- Disable AD User Account
- Query AD
- Reset AD User Password.

These activities share a common design, have complementary functionality, and share a common set of parameters. They can be used singly or together to create consistent workflows for provisioning and de-provisioning user accounts.

#### Update Active Directory with Orchestration

An organization plans to make their ServiceNow instance the single system of record for user account data and wants to update Active Directory with the latest changes.

The solution is to create an Orchestration workflow that pushes changes from the ServiceNow user record down to the Active Directory to create a new user record or update an existing record. This is accomplished by creating an Orchestration workflow that can create and update records in Active Directory based on the data in the ServiceNow User [sys_user] table.

**Note**: This example workflow assumes that ServiceNow is configured for LDAP and an LDAP server is configured to accept the new user accounts. The Active Directory user management activities are not dependent on LDAP, but the presence of LDAP makes this example workflow
much easier. You must provide the domain controller’s IP address to the workflow, either by hardcoding it, adding another workflow input, or using a script to look it up from the CMDB.

1. Navigate to Workflow > Workflow Editor.
2. In the Workflow tab, click the + icon to create a new workflow using these variables:
   - **Name**: Sync AD User
   - **Table**: Global [global]

3. Click Submit.
   A basic workflow with a Begin and End point appears on the canvas.

4. Click the menu icon in the upper left corner of the canvas and select **Edit Inputs** from the context menu.

   ![Image of workflow editor with menu options](image)

   **Editing workflow inputs**
5. In the Workflow Inputs form, click **New** in the **Variables** record list, and create a new variable, using the fields in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Reference</td>
</tr>
<tr>
<td>Label</td>
<td>User</td>
</tr>
<tr>
<td>Column name</td>
<td>u_user</td>
</tr>
<tr>
<td>Reference Specification &gt; Reference</td>
<td>User (sys_user)</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

7. In the **Custom** tab, expand **Custom Activities > Active Directory**.

8. Drag and drop the **Update AD Object** activity onto the transition line between the Begin and End points of the new workflow. This action automatically links the activity with the end point and opens the Workflow Activity property form.

9. Complete the form using the fields in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a logical name such as <strong>Update user data</strong>.</td>
</tr>
<tr>
<td>Domain controller</td>
<td>The ServiceNow LDAP integration adds a reference to the LDAP server to which the user's account is linked. To identify the LDAP server, enter the following statement: ${workflow.inputs.u_user.ldap_server.server_url}</td>
</tr>
<tr>
<td>Type</td>
<td>Type of AD object. In this case, the type is <strong>User</strong>, which is the default.</td>
</tr>
<tr>
<td>Object name</td>
<td>This example assumes that the ServiceNow user name matches the Active Directory sAMAccountName. Enter the following: ${workflow.inputs.u_user.user_name}</td>
</tr>
<tr>
<td>Object data</td>
<td>Updates the user's account in Active Directory, if the user exists. In this example, the user's title is updated: {&quot;title&quot; : &quot;QA&quot;}</td>
</tr>
</tbody>
</table>
10. Click **Submit**.

The workflow looks like this:

![Workflow diagram]

11. Attach both activity outcomes (Success and Failure) to the end point.

At this point, the workflow takes a ServiceNow user record as input and updates the First Name, Last Name, and Title of the corresponding Active Directory account. If the account does not exist in Active Directory, the workflow fails.

**Note:** In a normal workflow, some type of alternate action is desirable upon failure. For example, you might send an email notification if the workflow failed to update the record.

12. To prevent the workflow from failing, add a Create AD Object activity to the transition lines between Begin and the Update AD Object activity.

13. Complete the Workflow Activity property form using the fields in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a logical name such as <strong>Create user data</strong>.</td>
</tr>
<tr>
<td>Domain controller</td>
<td>Same as for the update activity. ${workflow.inputs.u_user.ldap_server.server_url}</td>
</tr>
<tr>
<td>Ou</td>
<td>The organizational unit to which this object belongs. For the purpose of this example, you can enter <strong>OU=HQ,OU=Managed Objects</strong></td>
</tr>
<tr>
<td>Object name</td>
<td>Same as for the update activity. ${workflow.inputs.u_user.user_name}</td>
</tr>
</tbody>
</table>
| Object data    | Creates an account with only the user name in it. For the purpose of this example, you can enter \{
|                |  "givenName" : \${workflow.inputs.u_user.first_name}, \n|                |  "SN" : \${workflow.inputs.u_user.last_name} \}                |

14. Click **Submit**.
15. **Connect the Failure outcome of the Create AD Object activity to End.**
   For this example, we are ignoring errors. The workflow now looks like this:

   ![Workflow Diagram](image)

Creating an AD user

This procedure builds a simple workflow that creates a bare-bones Active Directory account consisting of a user name only. The workflow then updates that account with additional information provided by the ServiceNow User [sys_user] table. However, we do not want to execute the Create AD Object activity if the user account already exists. The workflow needs to query Active Directory for matching user records and then branch the workflow based on the results of the query. If an account already exists, then the workflow should update the account. If the account does not exist, then the workflow should create the account in Active Directory.

16. **Drag and drop the Query AD activity onto the transition between Begin and Create AD Object.**

17. **Complete the Workflow Activity property form using the fields in the table.**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a logical name such as <strong>Search for existing account.</strong></td>
</tr>
<tr>
<td>Domain controller</td>
<td><code>${workflow.inputs.u_user.ldap_server.server_url}</code></td>
</tr>
<tr>
<td>Properties</td>
<td>A comma-separated list of Active Directory properties to return. For example, givenName, SN, title. If the parameter field is blank, then all properties are returned. In this workflow, we leave the field blank.</td>
</tr>
</tbody>
</table>
| Search filter | An LDAP filter string that defines the search parameters. Use any valid LDAP filtering criteria. To find user accounts matching the input record, we use:  
\{(samaccountname= 
${workflow.inputs.u_user.user_name} \})\) |

18. **Click Submit.**

19. **Connect the Failure outcome for the query activity to the End point.**
   Remember that we are ignoring errors in this workflow.
20. Connect the Success outcome of the query activity to the Update AD Object activity. The workflow now looks like this:

![Workflow Diagram]

Querying AD for user accounts

The Query AD activity returns its results as a JSON string in the workflow data bus. This JSON string is always an array of objects. Each object corresponds to an Active Directory entry that matched the query. Our workflow should branch, whether that array is empty or not.

21. Drag a standard If activity from the Conditions folder in the Core tab and drop it onto the transition between Query AD and Update AD Object.

22. Complete the Workflow Activity properties form using the fields in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a logical name such as <strong>Account exists</strong>.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to open the <strong>Script</strong> field.</td>
</tr>
</tbody>
</table>
For the If activity to work correctly, we must return a **yes** or **no** in the answer variable (var) which corresponds to the Yes and No outcomes of the query activity. Line 1 converts the Query AD results from a JSON string into a Javascript array called queryResults. Line 2 checks the length of that array. If the array is more than 0, a match to the account was found, and we set our answer to yes. Otherwise, the answer is no.

```javascript
var queryResults=new JSON().decode(data.get(5).output);
answer = ( queryResults.length>0 ? 'yes' : 'no' );
```

**Note:** The expression `data.get(5)` in this script identifies the Query AD output in the Databus by order number, since it was the fifth activity added to the workflow.
Query AD outputs in the Databus

23. Click **Submit**.

24. In the canvas, create a transition from the Yes outcome of the If activity to the Update AD Object activity.
25. Create a transition from the No outcome of the If activity to the Create AD Object activity.
This is the final step. This workflow will query Active Directory to determine if an account already exists. If an account exists, the workflow updates that account. If an account does not exist, the workflow creates the account and then updates the Active Directory with the configured user data set.

Creating the conditional paths

Orchestration activity packs

The base Orchestration system includes packs of custom activities you can use to automate typical IT and business processes in your network.

Activity packs allow you to automate several common business processes, such as managing Active Directory accounts and Exchange server mailboxes. Activity packs can also automate IT functions such as starting and stopping Windows servers, joining domains, assigning IP addresses, and configuring load balancers.

Use an activity pack

The Packs tab of the Workflow Editor contains any activity packs downloaded from the ServiceNow Store and any activity packs that you create.

Roles required: admin, activity_admin, activity_creator

You can organize custom activities into packs and upload them to the ServiceNow Store. Your custom packs do not appear in the tree until at least one activity in the pack is published. Activities added to an existing pack are not displayed until they are published. Activity packs from any application scope can appear in the Packs tab, regardless of the current scope setting for the instance.

1. In the Workflow Editor palette, select the Packs tab.
2. Click the download icon.

   The hierarchy in the tab organizes packs by vendor, scope, category, and activity.

   ![Download packs](image)

**Active Directory activity pack**

The Active Directory (AD) activity pack enables an administrator to create, delete, and manage objects in Windows Active Directory, such as users, groups, and computers, using a ServiceNow Orchestration workflow.

Activities in this pack can reset a password automatically from a user request or manage any user account in Active Directory, whether or not it was created by an Orchestration workflow.

Domain controllers are identified by the IP address of the host machine. To use the hostname of the domain controller, add the Resolve DNS Name activity to resolve the hostname into an IP, and then pass the IP into the Active Directory activity.

Your instance must have access to a MID Server configured to use PowerShell to run these activities.

**Note:** All Active Directory activities pass through error messages returned from Active Directory. To view these error messages, point to the failed activity in the workflow canvas or select the Workflow Log tab in a Workflow Context record.
Custom Active Directory activities

Orchestration provides custom Active Directory activities that were created with the Orchestration Create a PowerShell activity, starting with the Geneva release. These activities perform the same functions as AD activities by the same name from previous releases and replace those activities for all new workflows. Existing workflows from earlier versions that were created with legacy AD activities continue to function normally after an upgrade to Istanbul. However, all new workflows must use these custom AD activities. The Powershell activity template gives workflow administrators the ability to store input and output variables from the Query AD activity in the Databus.

Note: To use the Active Directory custom activities, you must request activation of the Orchestration - Active Directory plugin.

Active Directory credentials with LDAP

If you are using an LDAP Server with MID Servers, note that Orchestration and Active Directory activities do not use the user name and password configured on LDAP Servers. You must create a Windows type orchestration credential record. The username and password in the credentials record is used for LDAP queries that Orchestration and workflow activities perform.

Connection port used by AD Orchestration activities

All Active Directory activities use port 389 for LDAP access. If you are using AD activities with Oracle Virtual Directory (OVD) as a proxy, set up pass-through on port 389 only.

Add User to Group AD activity

The Add User to Group activity adds a user to a group in Windows Active Directory.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>UserName</td>
<td>Name of the user to add to the group.</td>
</tr>
<tr>
<td>GroupName</td>
<td>Name of the group to which this user is added.</td>
</tr>
</tbody>
</table>

Output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
</tbody>
</table>
### Conditions

Add User to Group conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>User was successfully added to group.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to add the user to the group. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

### Change AD User Password activity

The Change AD User Password activity changes the password for an Active Directory user account.

This activity requires the user's current password to run, unlike the Reset AD User Password activity. If the new password violates any Active Directory password requirements, such as length or character combinations, the activity fails and returns the appropriate error message. This error message appears in the ECC queue and in hint text when a user points to the activity in the Workflow Editor.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

**Note:** This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

### Input variables

**Change AD User Password input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>User</td>
<td>The sAMAccountName of the Active Directory user account.</td>
</tr>
<tr>
<td>New_password</td>
<td>The new password to assign this user.</td>
</tr>
<tr>
<td>Old_password</td>
<td>The user's current password.</td>
</tr>
</tbody>
</table>
Output variables

Change AD User Password output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>One of the following outcomes:</td>
</tr>
<tr>
<td></td>
<td>• failure</td>
</tr>
<tr>
<td></td>
<td>• success</td>
</tr>
<tr>
<td></td>
<td>• Policy Failure</td>
</tr>
<tr>
<td></td>
<td>• Incorrect old password</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources.</td>
</tr>
<tr>
<td>hresult</td>
<td>Powershell command result.</td>
</tr>
</tbody>
</table>

Conditions

The activity provides the following conditions:

Change AD User Password conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Password successfully reset.</td>
</tr>
<tr>
<td>Policy Failure</td>
<td>Password does not comply with the organization's Active Directory requirements.</td>
</tr>
<tr>
<td>Incorrect old password</td>
<td>Password being changed was not entered correctly.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to change the password. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Active Directory credentials with LDAP

If you are using an LDAP Server with MID Servers, note that Orchestration and Active Directory activities do not use the user name and password configured on LDAP Servers. You must create a Windows type orchestration credential record. The username and password in the credentials record is used for LDAP queries that Orchestration and workflow activities perform.

Create AD Object activity

The Create AD Object activity creates an object in Windows Active Directory. This activity fails if it finds an existing object with matching input variables.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.
**Note:** This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

### Input variables

**Create AD Object input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>Type</td>
<td>The object type to create: user, group, or computer.</td>
</tr>
<tr>
<td>OU</td>
<td>The organizational unit to which this object belongs.</td>
</tr>
</tbody>
</table>
| ObjectName   | The sAMAccountName of the Active Directory object.  
**Object name** is also used for the **name** attribute in Active Directory. This behavior is available in ActiveDirectory.psm1. Whatever is passed as the **Object name** becomes both the **samAccountName** and the **name** of the new user in Active Directory. |
| ObjectData   | A JSON object containing Active Directory property names and their corresponding values. For example: |
|              | ```json |
|              |   {  |
|              |     "givenName" : "John", |
|              |     "SN" : "Doe", |
|              |     "title" : "Sr. Account Specialist", |
|              |     "allowLogin" : true |
|              | } |
|              | This example sets the first name (givenName), last name (SN), and title on the Active Directory user account and allows that user to log in (allowLogin). This field allows expression evaluation via the `@` variable substitution syntax. |

### Output variables

**Create AD Object output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>
Conditions

Create AD Object conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>A Windows Active Directory object was created successfully.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to create the AD object. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Disable AD User Account activity

The Disable AD User Account activity disables a Windows Active Directory user account, making it inactive.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

ℹ️ Note: This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

Input variables

Disable AD User Account input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>User</td>
<td>The sAMAccountName of the Active Directory user account.</td>
</tr>
</tbody>
</table>

Output variables

Disable AD User Account output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>
Conditions

Disable AD User Account conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>AD user account was successfully disabled.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to disable the account. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Enable AD User Account activity

The Enable AD User Account activity enables a Windows Active Directory user account, making it active. To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

Note: This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

Input variables

Enable AD User Account input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>The sAMAccountName of the Active Directory user account.</td>
</tr>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
</tbody>
</table>

Output variables

Enable AD User Account output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>
Conditions

Enable AD User Account conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>AD user account was successfully enabled.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to enable the AD user account. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Is AD Account Locked activity

The Is AD Account Locked activity determines whether an Active Directory user account is locked. An account may be locked automatically if a user enters an incorrect password more times than allowed by the Active Directory security policy. You can unlock an account using the Unlock AD User Account activity. To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

**Note:** This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

Input variables

Is AD Account Locked input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>User</td>
<td>The sAMAccountName of the Active Directory user account.</td>
</tr>
</tbody>
</table>

Output variables

Is AD Account Locked output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
<tr>
<td>output</td>
<td>The query result.</td>
</tr>
</tbody>
</table>
Conditions

Is AD Account Locked conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locked</td>
<td>The AD account is locked.</td>
</tr>
<tr>
<td>Unlocked</td>
<td>The AD account is unlocked.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while processing the query.</td>
</tr>
<tr>
<td></td>
<td>Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Query AD activity

The Query AD activity retrieves entries from the Windows Active Directory based on an LDAP search filter and stores the results as a JSON string that can be used in the data bus.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory > .

Note: This activity replaces an AD activity by the same name available in releases prior to Geneva. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul and will continue to save query results to the scratchpad. However, all new workflows must use the custom version of this activity. This activity was built with the Create a PowerShell activity, which stores input and output variables in the databus instead of the scratchpad.

Input variables

Query AD input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>Properties</td>
<td>A comma-separated list of Active Directory properties to return. For example, givenName,SN,title. If this field is blank, then all properties are returned.</td>
</tr>
<tr>
<td>SearchFilter</td>
<td>An LDAP filter string that defines the search parameters. Use any valid LDAP filtering criteria. For example, to find user accounts matching the ServiceNow input record, use: (samaccountname=${workflow.inputs.u_user.user_name})</td>
</tr>
</tbody>
</table>
Output variables

Query AD output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
<tr>
<td>output</td>
<td>The query result.</td>
</tr>
</tbody>
</table>

Conditions

Query AD conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The query completed as expected.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while processing the query. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Remove AD Object activity

The Remove AD Object activity deletes an object from Windows Active Directory.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

Note: This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

Input variables

Remove AD Object input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>ObjectName</td>
<td>The sAMAccountName of the Active Directory object.</td>
</tr>
<tr>
<td>Type</td>
<td>The object type to remove:</td>
</tr>
<tr>
<td></td>
<td>• user</td>
</tr>
<tr>
<td></td>
<td>• group</td>
</tr>
<tr>
<td></td>
<td>• computer</td>
</tr>
</tbody>
</table>
Output variables

Remove AD Object output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

Conditions

Remove AD Object conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>AD object was successfully removed.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to remove the AD object. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Remove User from Group AD activity

The Remove User from Group activity removes a user from a group in Windows Active Directory.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

Input variables

Remove User from Group input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>UserName</td>
<td>Name of the user to remove from the group.</td>
</tr>
<tr>
<td>GroupName</td>
<td>Name of the group from which this user is removed.</td>
</tr>
</tbody>
</table>

Output variables

Remove User from Group output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
</tbody>
</table>
Variable | Description
--- | ---
errorMessage | The `executionResult.errorMessages` from the Activity designer parsing sources.

## Conditions

### Remove User from Group conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>User was successfully removed from the group.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to remove the user from the group. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

## Reset AD User Password activity

The Reset AD User Password activity resets the password of a user account in Windows Active Directory. If the new password violates any Active Directory password requirements, such as length or character combinations, the reset activity fails and returns the appropriate error message. This error appears in the ECC Queue and when you point to the activity in the Workflow Editor.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Active Directory**.

**Note:** This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

## Input variables

### Reset AD User Password input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>User</td>
<td>The <code>sAMAccountName</code> of the Active Directory user account.</td>
</tr>
<tr>
<td>Password</td>
<td>The new password for the user. This password must comply with the organization’s Active Directory requirements.</td>
</tr>
<tr>
<td>ForceChange</td>
<td>Makes this password temporary by forcing the user to change it at the next login.</td>
</tr>
<tr>
<td>Unlock</td>
<td>Unlock the account if the account is locked.</td>
</tr>
</tbody>
</table>
Output variables

Reset AD User Password output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>One of the following outcomes:</td>
</tr>
<tr>
<td></td>
<td>• failure</td>
</tr>
<tr>
<td></td>
<td>• success</td>
</tr>
<tr>
<td></td>
<td>• Policy Failure</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources.</td>
</tr>
<tr>
<td>hresult</td>
<td>Powershell command result.</td>
</tr>
</tbody>
</table>

Conditions

Reset AD User Password conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Password was successfully reset.</td>
</tr>
<tr>
<td>Policy Failure</td>
<td>New password does not comply with the organization's Active Directory requirements.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to reset the password. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

Unlock AD Account activity

The Unlock AD Account activity unlocks a locked Active Directory user account.

You can use the Is AD Account Locked activity activity to determine if an account is locked.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

Note: This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

Input variables

Unlock AD Account input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
</tbody>
</table>
### Output variables

#### Unlock AD Account output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

### Conditions

#### Unlock AD Account conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The account was successfully unlocked.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to unlock the account. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

### Update AD Object activity

The Update AD Object activity updates an object in Windows Active Directory.

This activity only replaces existing values with new values. It cannot add new values to AD records such as adding a new group member to an AD group. For complex AD operations, use the Run PowerShell activity instead. The activity fails if it cannot find an existing account with matching object name and data.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Active Directory**.

**Note:** This activity replaces an AD activity by the same name available in prior releases. If you have a workflow that uses the deprecated activity, your workflow will continue to work normally after upgrading to Instanbul. However, all new workflows must use the custom version of this activity, which was built with the PowerShell activity designer.

### Input variables

#### Update AD Object input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DomainController</td>
<td>IP address of the domain controller machine.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ObjectName</td>
<td>The sAMAccountName of the Active Directory object.</td>
</tr>
<tr>
<td>ObjectData</td>
<td>A JSON object containing Active Directory properties and their values. For example, to set the first name, last name, and title of a user, clear the user’s manager, and set the VIP flag to true, the Object Data specifies: { &quot;givenName&quot; : &quot;John&quot;, &quot;SN&quot; : &quot;Doe&quot;, &quot;title&quot; : &quot;Sr. Account Specialist&quot;, &quot;manager&quot; : null, &quot;msTSAllowLogon&quot; : false }</td>
</tr>
<tr>
<td>Type</td>
<td>The object type to update: user, group, or computer.</td>
</tr>
</tbody>
</table>

**Output variables**

**Update AD Object output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

**Conditions**

**Update AD Object conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>AD object was successfully updated.</td>
</tr>
<tr>
<td>Failure</td>
<td>An error occurred while attempting to update an AD object. Additional details may be available in the workflow log.</td>
</tr>
</tbody>
</table>

**Azure AD activity pack**

The Azure AD activity pack enables an administrator to automate employee onboarding and offboarding functions on Azure AD and manage Office 365 licensing.

Use the Azure AD activities to add and remove users to Azure Active Directory, manage security group membership, and assign or remove Office 365 licenses for individual users.

The Azure AD activities were created with the Orchestration REST Web Service activity template.

**Add User to Group Azure AD activity**

The Add User to Group activity adds a user to an existing security group in Azure Active Directory.
To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Azure AD**. This activity was built with the REST web service activity template.

**Important:** The REST message used for this activity must be configured to use OAuth2 authentication.

### Input variables

**Add User to Group input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>Object ID (GUID) of the member to be added.</td>
</tr>
<tr>
<td>group_id</td>
<td>Object ID (GUID) of the target group.</td>
</tr>
</tbody>
</table>

### Output variables

**Add User to Group output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
</tbody>
</table>

### Conditions

**Add User to Group conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully added the object ID to the security group.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to update the group's membership, or the activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>

**Assign User License Azure AD activity**

The Assign User License activity assigns an additional Office 365 software license to the named user.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Azure AD**. This activity was built with the REST web service activity template.
Important: The REST message used for this activity must be configured to use OAuth2 authentication.

Input variables

Assign User License input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>The object ID (GUID) or the user principal name of the target user. An example of a user principal name is <a href="mailto:someuser@a830edad9050849NDA1.onmicrosoft.com">someuser@a830edad9050849NDA1.onmicrosoft.com</a>.</td>
</tr>
<tr>
<td>sku_id</td>
<td>Subscription SKU ID associated with the tenant's enterprise agreement.</td>
</tr>
</tbody>
</table>

Output variables

Assign User License output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
</tbody>
</table>

Conditions

Assign User License conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully assigned an Office 365 license to a user.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to assigned an Office 365 license to a user, or the activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>

Create User Azure AD activity

The Create User activity creates a user for the Azure Active Directory tenant.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Azure AD. This activity was built with the REST web service activity template.
**Important:** The REST message used for this activity must be configured to use OAuth2 authentication.

## Input variables

Create User input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>display_name</td>
<td>Name of the Azure AD user in the accepted display format, such as <em>jacinto.gawron</em>.</td>
</tr>
<tr>
<td>user_principal_name</td>
<td>User principal name (UPN) in an email format. For example, you might enter <em><a href="mailto:jacinto.gawron@khitomer.com">jacinto.gawron@khitomer.com</a></em>.</td>
</tr>
<tr>
<td>mail_nickname</td>
<td>User's email alias that redirects to the user's full address.</td>
</tr>
<tr>
<td>password</td>
<td>User's Azure AD password. This password must be passed as a workflow input with a type of <strong>Password (2 Way Encrypted)</strong> and must meet the password policy set in Azure AD.</td>
</tr>
<tr>
<td>change_password</td>
<td>Control that requires the user to change his or her password at the next login, if set to true.</td>
</tr>
<tr>
<td>account_enabled</td>
<td>Control that sets the user's account is enabled, if set to true.</td>
</tr>
<tr>
<td>given_name</td>
<td>First name of the user.</td>
</tr>
<tr>
<td>surname</td>
<td>Last name of the user.</td>
</tr>
<tr>
<td>other_mails</td>
<td>List of additional email addresses for the user. For example, you might enter <em>&quot;<a href="mailto:jac@home.com">jac@home.com</a>&quot;, &quot;<a href="mailto:jgawron@fabrikam.com">jgawron@fabrikam.com</a>&quot;</em>.</td>
</tr>
<tr>
<td>country</td>
<td>The country or region in which the user is located. For example, you might enter <strong>US</strong> or <strong>UK</strong>. The default value is set to <strong>US</strong>.</td>
</tr>
<tr>
<td>city</td>
<td>City in which the user is located.</td>
</tr>
<tr>
<td>department</td>
<td>Name of the department in which the user works.</td>
</tr>
<tr>
<td>mobile</td>
<td>User's primary cell phone number.</td>
</tr>
<tr>
<td>job_title</td>
<td>User's job title.</td>
</tr>
<tr>
<td>physical_delivery_office_name</td>
<td>Office location in the user place of business.</td>
</tr>
<tr>
<td>postal_code</td>
<td>Postal code of the user's address.</td>
</tr>
<tr>
<td>preferred_language</td>
<td>Language in which the user prefers to communicate. This value must follow the ISO 639-1 Code. For example, you might enter <strong>en-US</strong>. The default value is set to <strong>en-US</strong>.</td>
</tr>
<tr>
<td>state</td>
<td>State or province for the user's address.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>street_address</td>
<td>Street address of the user's place of business.</td>
</tr>
<tr>
<td>telephone_number</td>
<td>Primary telephone number of the user’s place of business.</td>
</tr>
<tr>
<td>usage_location</td>
<td>Two letter country code that is required for users who are assigned Office 365 licenses. The default value is US.</td>
</tr>
</tbody>
</table>

**Output variables**

Create User output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
<tr>
<td>user_exists</td>
<td>Output variable mapped to the JSON message that contains the User already exists error.</td>
</tr>
</tbody>
</table>
| user_info  | The user_info array contains attributes that can be leveraged by other activities as inputs. For example, the user objectid output (GUID) can be passed to the Add User to Group activity as the user_id input.  
  - objectid: User’s Azure AD identifier.  
  - accountEnabled: Boolean variable indicating whether the user’s account is active or inactive.  
  - displayName: Users display name, such as jacinto.gawron.  
  - userPrincipalName: User’s name in email format, such as jacinto.gawron@wammo.com.  
  - mailNickname: User’s email alias. |

**Conditions**

Create User conditions

<table>
<thead>
<tr>
<th>Conditions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created user</td>
<td>Activity successfully created the user.</td>
</tr>
<tr>
<td>User already exists</td>
<td>User already exists in the tenant domain.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to connect to Azure AD, or an input value was invalid.</td>
</tr>
</tbody>
</table>
Delete User Azure AD activity

The Delete User activity deletes the named user's account from the Azure Active Directory tenant.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Azure AD**. This activity was built with the **REST web service activity template**.

**Important:** The REST message used for this activity must be configured to use OAuth2 authentication.

### Input variables

**Delete User input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>The object ID (GUID) or the user principal name of the target user. An example of a user principal name is <a href="mailto:someuser@a830edad9050849NDA1.onmicrosoft.com">someuser@a830edad9050849NDA1.onmicrosoft.com</a>.</td>
</tr>
</tbody>
</table>

### Output variables

**Delete User output variables**

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
</tbody>
</table>

### Conditions

**Delete User conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted user</td>
<td>Activity deleted the specified user.</td>
</tr>
<tr>
<td>User does not exist</td>
<td>Specified user does not have an account in the tenant domain.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>

Get User Info Azure AD activity

The Get User Info activity returns the named user's information from the Azure Active Directory.
To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Azure AD**. This activity was built with the **REST** web service activity template.

**Important:** The REST message used for this activity must be configured to use OAuth2 authentication.

### Input variables

**Check If User Exists input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>The object ID (GUID) or the user principal name of the target user. An example of a user principal name is <code>someuser@a830edad9050849NDA1.onmicrosoft.com</code></td>
</tr>
</tbody>
</table>

**Note:** Version 2 of this activity enforces input validation. If empty, the following message appears: "Mandatory input 'user_id' is empty".

### Output variables

**Check If User Exists output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
<tr>
<td>user_info</td>
<td>The <strong>user_info</strong> array contains attributes that can be leveraged by other activities as inputs. For example, the user <strong>objectid</strong> output (GUID) can be passed to the Add User to Group activity as the <strong>user_id</strong> input.</td>
</tr>
</tbody>
</table>

- **objectid**: User's Azure AD identifier.
- **accountEnabled**: Boolean variable indicating whether the user's account is active or inactive.
- **displayName**: Users display name, such as `jacinto.gawron`.
- **userPrincipalName**: User's name in email format, such as `jacinto.gawron@wammo.com`.
- **mailNickname**: User's email alias.
Conditions

Check If User Exists conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User exists</td>
<td>Activity found the named user.</td>
</tr>
<tr>
<td>User does not exist</td>
<td>Activity was unable to find the named user in the customer tenant domain.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>

Remove User from Group Azure AD activity

The Remove User from Group activity removes an existing user from a security group in Azure Active Directory.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Azure AD. This activity was built with the REST web service activity template.

Important: The REST message used for this activity must be configured to use OAuth2 authentication.

Input variables

Remove User from Group input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>Object ID (GUID) of the user to be removed.</td>
</tr>
<tr>
<td>group_id</td>
<td>Object ID (GUID) of the target group.</td>
</tr>
</tbody>
</table>

Output variables

Remove User from Group output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
</tbody>
</table>
Conditions

Remove User from Group conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity removed the object ID from the security group.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to update the group's membership, or the activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>

Remove User License Azure AD activity

The Remove User License activity revokes the specified Office 365 software license for the named user.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Azure AD. This activity was built with the REST web service activity template.

**Important:** The REST message used for this activity must be configured to use OAuth2 authentication.

Input variables

Remove User License input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>The object ID (GUID) or the user principal name of the target user. An example of a user principal name is <code>someuser@a830edad9050849NDA1.onmicrosoft.com</code>.</td>
</tr>
<tr>
<td>sku_id</td>
<td>Subscription SKU ID associated with the tenant's enterprise agreement.</td>
</tr>
</tbody>
</table>

Output variables

Remove User License output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
</tbody>
</table>
Conditions

Remove User License conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity removed an Office 365 license from the named user.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to remove an Office 365 from a user, or the activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>

Reset User Password Azure AD activity

The Reset User Password activity changes the named user’s Azure Active Directory password. The Azure password policy imposes constraints on the complexity, length, and re-use of a password.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Azure AD. This activity was built with the REST web service activity template.

**Important:** The REST message used for this activity must be configured to use OAuth2 authentication.

Input variables

Reset User Password input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_id</td>
<td>The object ID (GUID) or the user principal name of the target user. An example of a user principal name is <a href="mailto:someuser@a830edad9050849NDA1.onmicrosoft.com">someuser@a830edad9050849NDA1.onmicrosoft.com</a>.</td>
</tr>
<tr>
<td>password</td>
<td>User’s Azure AD password. This password must be passed as a workflow input with a type of Password (2 Way Encrypted) and must meet the password policy set in Azure AD.</td>
</tr>
<tr>
<td>change_password</td>
<td>Control that requires the user to change his or her password at the next login, if set to true.</td>
</tr>
</tbody>
</table>

Output variables

Reset User Password output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Returns the error string from the REST message. If there are no errors, this variable returns a null value.</td>
</tr>
<tr>
<td>body</td>
<td>Contains a string value representing the output from the REST message.</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>status_code</td>
<td>Contains the status code returned from the Web service.</td>
</tr>
</tbody>
</table>

### Conditions

#### Reset User Password conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity reset the named user's password.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to reset the named user's password, or the activity failed to connect to Azure AD.</td>
</tr>
</tbody>
</table>

### Exchange activity pack

The Exchange activity pack allows workflows to manage Microsoft Exchange mail systems.

The use of Orchestration Exchange activities requires the following:

- Microsoft Exchange 2010 or 2013.
- A MID Server configured to run Powershell 2.0
- A target Exchange server in the same Active Directory domain as the instance.
- Powershell Remoting enabled on the target Exchange server.

**Note:** These activities cannot be used to interact with Microsoft Exchange Online.

Orchestration provides custom Exchange activities that were created with the Orchestration activity designer template. These activities perform the same functions as Exchange activities by the same name from previous releases and replace those activities for all new workflows. The custom Exchange activities were built with a Powershell activity template, which gives workflow administrators the ability to store input and output variables in the databus.

**Note:** Existing workflows from earlier versions that were created with legacy Exchange activities continue to function normally after an upgrade to Geneva. However, all new workflows must use these custom Exchange activities.

To use the Microsoft Exchange custom activities, you must request activation of the Orchestration - Exchange plugin. The custom Exchange activities are available in the Workflow Editor on the Custom tab. Expand the Custom Activities tree and select the Exchange category for the activity you want to use.
Configure MID Server for Exchange

Configure a MID Server with defined IP ranges to use Exchange.
If the MID Server manages resources within defined IP ranges, instead of all computers on your network, you must perform additional configuration steps to run Exchange activities. You do not need to perform these steps if your MID Server uses the default configuration.

1. In the navigation filter, enter `cmdb_ci_dns_name.list`.
2. Click **New**.
3. Enter the fully-qualified domain name (FQDN) of your Exchange server in the **Name** field.
4. Right-click the form header and select **Save**.
5. In the **IP Address** related list, click **New**.
6. In the **IP Address** field, enter the IP address of your Exchange server.
7. In the **Nic** field, select **eth0** or your preferred network interface controller.
8. Leave the **Netmask** field blank.
9. Click **Submit**.

**Pass multivalued properties with an Exchange activity**

To set a multivalued property using an Exchange activity, you must use a specific parameter format.

The Optional parameters shared input variable allows you to set multivalued properties.

- To set a multivalued property, replacing any existing values, use this format:
  
  "PropertyName":"(value1, value2, value3)"

- To add values, use this format: "PropertyName":"+(value1, value2, value3);"

- To remove values, use this format: "PropertyName":"-(value1, value2, value3);"

- To both add and remove values, use this format: "PropertyName":"-(value1, value2, value3);+(value1, value2, value3);"

**Create Address List activity**

The Create Address List activity creates a new address list that acts as an alias for emailing all users in the group.

This alias cannot be used to manage user permissions. This activity implements the Microsoft Exchange `New-AddressList` command.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Exchange > Address List**.

**Note**: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

**Input variables**

**Create Address List input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>name</td>
<td>Name of the new address list to create.</td>
</tr>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
</tr>
</tbody>
</table>

**Note:** When passing a switch parameter, such as ForceUpgrade, you must use the format “parameter”:“true”.

### Output variables

**Create Address List output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
<tr>
<td>output</td>
<td>Raw XML payload from the Exchange server. This data includes all Exchange attributes.</td>
</tr>
</tbody>
</table>

### Conditions

**Create Address List conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in creating a new address list.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to create a new address list.</td>
</tr>
</tbody>
</table>

### Delete Address List activity

The Delete Address List activity removes an existing address list from an Exchange server.

This activity implements the Microsoft Exchange Remove-AddressList command.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Address List.
Note: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Delete Address List input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>identity</td>
<td>Name of the address list to remove.</td>
</tr>
<tr>
<td>domainController</td>
<td>Fully-qualified domain name (FQDN) of the domain controller that writes to Active Directory.</td>
</tr>
<tr>
<td>recursive</td>
<td>Check box that indicates if the activity should delete Active Directory elements that are children of the specified address list.</td>
</tr>
<tr>
<td>whatif</td>
<td>Check box that indicates if the activity should stage the changes without applying them. Use this variable to test your activity settings before using the activity in a live workflow. When this variable is selected, the Exchange server does not make any changes but indicates if the command would succeed or fail. You can review any messages from the Exchange server using the ECC queue.</td>
</tr>
</tbody>
</table>

Output variables

Delete Address List output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>
Conditions

Delete Address List conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in removing the address list from the Exchange server.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to remove the address list from the Exchange server.</td>
</tr>
</tbody>
</table>

Get Address List activity

The Get AddressList activity retrieves all attributes from the specified Exchange address list. This activity implements the Microsoft Exchange Get-AddressList command.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Address List.

Note: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Get Address List input variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>domainController</td>
<td>Fully-qualified domain name (FQDN) of the domain controller that writes to Active Directory.</td>
</tr>
<tr>
<td>identity</td>
<td>Name of the address list to get attributes from. If you enter a value in this variable, leave the container and searchText variables blank.</td>
</tr>
<tr>
<td>organization</td>
<td>Organization to which the specified address list belongs.</td>
</tr>
<tr>
<td>searchText</td>
<td>Filter text that causes the activity to return only results that contain this text. This variable can only be used with Exchange 2013 servers. If you enter a value in this variable, leave the container and identity variables blank.</td>
</tr>
</tbody>
</table>
Variables | Description
--- | ---
container | Parent address list of the address list from which you want to retrieve attributes. If you enter a value in this variable, leave the identity and searchText variables blank.

Output variables

Get Address List output variables

| Variables | Descriptions |
--- | --- |
result | Either success or failure. |
error | Error message if the operation fails. |
output | Raw XML payload from the Exchange server. This data includes all Exchange attributes. |

Conditions

Get Address List conditions

| Condition | Description |
--- | --- |
Success | The activity succeeded in retrieving the attributes from the address list. |
Failure | The activity failed to retrieve the attributes from the address list. |

Move Address List activity

The Move Address List activity moves a Microsoft Exchange address list to another location in the address hierarchy.

This activity implements the Microsoft Exchange Move-AddressList command.

The Exchange server caches the changes from this activity but does not immediately apply them. Use the Update Address List activity after this activity to apply the changes or wait for the Exchange server to automatically apply cached changes.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Address List.

Note: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.
## Input variables

### Move Address List input variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>identity</td>
<td>Name of the address list to move.</td>
</tr>
<tr>
<td>target</td>
<td>Path to the address list's new location.</td>
</tr>
<tr>
<td>domainController</td>
<td>Fully-qualified domain name (FQDN) of the domain controller that writes to Active Directory.</td>
</tr>
<tr>
<td>whatif</td>
<td>Check box that indicates if the activity should stage the changes without applying them. Use this variable to test your activity settings before using the activity in a live workflow. When this variable is selected, the Exchange server does not make any changes but indicates if the command would succeed or fail. You can review any messages from the Exchange server using the ECC queue.</td>
</tr>
</tbody>
</table>

## Output variables

### Move Address List output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>

## Conditions

### Move Address List conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in moving the address list to another location.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to move the address list to another location.</td>
</tr>
</tbody>
</table>

## Set Address List activity

The Set Address List activity modifies a Microsoft Exchange address list.
Use the Optional parameters variable to pass specific values to the Microsoft Exchange server. This activity implements the Microsoft Exchange Set-AddressList command.

The Exchange server caches the changes from this activity but does not immediately apply them. Use the Update Address List after this activity to apply the changes or wait for the Exchange server to automatically apply cached changes.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Exchange > Address List**.

**Note**: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

### Input variables

**Set Address List input variables**

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>identity</td>
<td>Name of the address list to modify.</td>
</tr>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
</tr>
</tbody>
</table>

**Note**: When passing a switch parameter, such as ForceUpgrade, you must use the format "parameter":"true".
Output variables

Set Address List output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>

Conditions

Set Address List conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in modifying the specified address list.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to modify the specified address list.</td>
</tr>
</tbody>
</table>

Update Address List activity

The Update Address List activity adds or removes users from the specified address list and immediately applies any cached address list changes to the server.

Use the optional parameters variable to specify which users to add or remove. This activity implements the Microsoft Exchange Update-AddressList command.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Address List.

Note: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Update Address List input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server’s assigned domain.</td>
</tr>
<tr>
<td>identity</td>
<td>Name of the address list to update.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>domainController</td>
<td>Fully-qualified domain name (FQDN) of the domain controller that writes to Active Directory.</td>
</tr>
<tr>
<td>whatif</td>
<td>A check box that indicates if the activity should stage the changes without applying them. Use this variable to test your activity settings before using the activity in a live workflow. When this variable is selected, the Exchange server does not make any changes but indicates if the command would succeed or fail. You can review any messages from the Exchange server using the ECC queue.</td>
</tr>
</tbody>
</table>

**Output variables**

**Update Address List output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>Success</strong> or <strong>Failure</strong>.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>

**Conditions**

**Update Address List conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in adding or removing users from the specified address list.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to add or remove users from the specified address list.</td>
</tr>
</tbody>
</table>

**Create Mailbox activity**

The Create Mailbox activity creates a new Active Directory user, if that user does not already exist, and a Microsoft Exchange mailbox for that user.

This activity implements the Microsoft Exchange **New-Mailbox** command.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Exchange > Mailbox**.

**Note:** This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.
### Input variables

**Create Mailbox input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain. <strong>Important:</strong> The MID Server must be in the same domain as the Exchange server.</td>
</tr>
<tr>
<td>first_name</td>
<td>First name of the user.</td>
</tr>
<tr>
<td>middle_initial</td>
<td>Middle initial of the user.</td>
</tr>
<tr>
<td>last_name</td>
<td>Last name of the user.</td>
</tr>
<tr>
<td>alias</td>
<td>The display name for the mailbox address, the part of the email address to the left of the @ symbol. If no alias is specified, the activity uses First name.Last name as the alias. The alias is also used as the user's principal name (UPN) if none is specified in the optional parameters.</td>
</tr>
<tr>
<td>password</td>
<td>Password to use for the new mailbox. The password is encrypted when it is sent to the target host.</td>
</tr>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear. <strong>Note:</strong> When passing a switch parameter, such as ForceUpgrade, you must use the format &quot;parameter&quot;:&quot;true&quot;.</td>
</tr>
</tbody>
</table>

### Output variables

**Create Mailbox output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
<tr>
<td>output</td>
<td>Raw XML payload from the Exchange server. This data includes all Exchange attributes.</td>
</tr>
</tbody>
</table>

### Conditions

#### Create Mailbox conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in creating a new mailbox for the specified user. If no Active Directory account existed for that user, this activity succeeded in creating a new account.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to create a new mailbox or an Active Directory account for the specified user.</td>
</tr>
</tbody>
</table>

#### Delete Mailbox activity

The Delete Mailbox activity deletes the Microsoft Exchange mailbox of an Active Directory user.

Optional parameters determine how the Exchange server handles the mailbox after deleting the user. This activity implements the Microsoft Exchange Remove-Mailbox command.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Mailbox.

**Note:** This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

### Input variables

#### Delete Mailbox input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>user</td>
<td>Active Directory user to delete. The activity passes this value to Exchange as the Identity Exchange variable.</td>
</tr>
</tbody>
</table>
### Variable parameters
Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.

**Note:** When passing a switch parameter, such as ForceUpgrade, you must use the format "parameter":"true".

### Output variables
#### Delete Mailbox output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>

### Conditions
#### Delete Mailbox conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in deleting the specified user’s mailbox.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to delete the specified user’s mailbox.</td>
</tr>
</tbody>
</table>

### Disable Mailbox activity
The Disable Mailbox activity disables the mailbox associated with a specified Active Directory account.

This activity implements the Microsoft Exchange Disable-Mailbox command.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Mailbox.

**Note:** This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity.
designer, which gives workflow administrators the ability to store input and output variables in the databus.

### Input variables

#### Disable Mailbox input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>user</td>
<td>Active Directory user who's mailbox should be disabled. The activity passes this value to Exchange as the Identity Exchange variable.</td>
</tr>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
</tr>
</tbody>
</table>

**Note:** When passing a switch parameter, such as ForceUpgrade, you must use the format "parameter":"true".

### Output variables

#### Disable Mailbox output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>
Conditions

Disable Mailbox conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in disabling the specified mailbox.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to disable the specified mailbox.</td>
</tr>
</tbody>
</table>

Enable Mailbox activity

The Enable Mailbox activity creates a new mailbox for an existing Active Directory user.

This activity implements the Microsoft Exchange `Enable-Mailbox` command.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Exchange > Mailbox**.

**Note:** This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Enable Mailbox input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>user</td>
<td>Active Directory user who's mailbox should be enabled. The activity passes this value to Exchange as the Identity Exchange variable.</td>
</tr>
</tbody>
</table>
### Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
</tr>
</tbody>
</table>

**Note:** When passing a switch parameter, such as ForceUpgrade, you must use the format “parameter”:“true”.

### Output variables

Enable Mailbox output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>

### Conditions

Enable Mailbox conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in creating a new mailbox for the specified user.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to create a new mailbox for the specified user.</td>
</tr>
</tbody>
</table>

### Get Mailbox activity

The Get Mailbox activity gets the mailbox for the specified user or all mailboxes on a Microsoft Exchange server.

This activity implements the Microsoft Exchange Get-Mailbox command.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Mailbox.

**Note:** This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows...
must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Get Mailbox input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>user</td>
<td>User whose mailbox this activity should retrieve. If no user is specified, the activity gets all mailboxes on the Exchange server. The activity passes this value to Exchange as the Identity Exchange variable.</td>
</tr>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
</tr>
</tbody>
</table>

Note: When passing a switch parameter, such as ForceUpgrade, you must use the format "parameter": "true".

Output variables

Get Mailbox output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
<tr>
<td>output</td>
<td>Raw XML payload from the Exchange server. This data includes all Exchange attributes.</td>
</tr>
</tbody>
</table>
Conditions

Get Mailbox conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in retrieving the attributes of the specified mailbox.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to retrieve the attributes of the specified mailbox.</td>
</tr>
</tbody>
</table>

Set Mailbox activity

The Set Mailbox activity modifies the settings of an existing Microsoft Exchange mailbox.

Use the optional parameters variable to pass specific values to the Exchange server. This activity implements the Microsoft Exchange Set-Mailbox command.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Exchange > Mailbox.

Note: This activity replaces an Exchange activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Set Mailbox input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>The hostname of the Exchange server with which the activity interacts. Do not enter an IP address in this variable.</td>
</tr>
<tr>
<td>domain</td>
<td>The name of the Exchange server's assigned domain.</td>
</tr>
<tr>
<td>user</td>
<td>Active Directory user whose mailbox you want to modify. The activity passes this value to Exchange as the Identity Exchange variable.</td>
</tr>
</tbody>
</table>
### Variable Description

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>parameters</td>
<td>Optional parameters to pass to the Exchange server written in JavaScript Object Notation (JSON). Exchange activities cannot pass parameters that reference an object, such as a PSCredential object. Plain text is automatically converted to SecureString objects for parameters that require that data type. Attempting to save an activity that specifies duplicate parameters, including parameters from activity variables, or incorrectly formatted JSON causes a warning message to appear.</td>
</tr>
</tbody>
</table>

**Note:** When passing a switch parameter, such as `ForceUpgrade`, you must use the format `"parameter":"true"`.  

### Output variables

**Set Mailbox output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either <strong>success</strong> or <strong>failure</strong>.</td>
</tr>
<tr>
<td>error</td>
<td>Error message if the operation fails.</td>
</tr>
</tbody>
</table>

### Conditions

**Set Mailbox conditions**

<table>
<thead>
<tr>
<th>Conditions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in modifying the settings of the specified mailbox.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to modify the settings of the specified mailbox.</td>
</tr>
</tbody>
</table>

### F5 Network Management activity pack

Orchestration provides custom activities for configuring elements of an F5 load balancer, including pools, pool members, and the virtual servers contained in the pool.

All F5 custom activities are in the F5 Network Management Application scope and are activated by the Orchestration - F5 network management plugin, which must be activated by request.

ServiceNow provides custom F5 activities, built from the REST web service activity template, that you can use to perform the following tasks:

- Add, delete, or verify pools.
• Add, delete, or identify pool members.
• Add or delete virtual servers.
• Add a profile to a virtual server.
• Configure the virtual server for vlans, irules, pool, and persistence.

Add F5 Pool Member activity

The Add F5 Pool Member activity adds a member to an F5 load balancer pool.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings

• REST message: F5 POOL Membership Management
• REST function: post

Input variables

Add F5 Pool Member input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PoolName</td>
<td>Name of this pool, such as testPool.</td>
</tr>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>MemberName</td>
<td>Pool member IP address and port, such as 192.168.2.19:80.</td>
</tr>
</tbody>
</table>

Output variables

Add F5 Pool Member output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
<tr>
<td>output</td>
<td>The REST output.</td>
</tr>
</tbody>
</table>
Conditions

Add F5 Pool Member conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully added an F5 load balancer pool member.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to add an F5 load balancer pool member.</td>
</tr>
</tbody>
</table>

Get F5 Pool Member activity

The Get F5 Pool Member activity returns the pool members and verifies the pool's status.

Use this activity to verify that a pool member was created properly.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings

- **REST message**: F5 POOL Membership Management
- **REST function**: get

Input variables

Get F5 Pool Member input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PoolName</td>
<td>Name of this pool, such as testPool.</td>
</tr>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
</tbody>
</table>

Output variables

Get F5 Pool Member output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MembersArray</td>
<td>Array for the returned pool member IP address and port, such as 192.168.2.19:80.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>output</td>
<td>The REST output.</td>
</tr>
</tbody>
</table>
Conditions

Get F5 Pool Member conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully returned the F5 load balancer pool members.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to return the F5 load balancer pool members</td>
</tr>
</tbody>
</table>

Delete F5 Virtual Server activity

The Delete F5 Virtual Server activity deletes a virtual server from an F5 load balancer pool.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings

- REST message: F5 VIP Management
- REST function: delete

Input variables

Delete F5 Virtual Server input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>name</td>
<td>The virtual server's name, such as testVIP.</td>
</tr>
</tbody>
</table>

Output variables

Delete F5 Virtual Server output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
</tbody>
</table>
Conditions

Delete F5 Virtual Server conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully deleted the virtual server from the F5 load balancer pool.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to delete the virtual server from the F5 load balancer pool.</td>
</tr>
</tbody>
</table>

Check F5 Pool activity

The Check F5 Pool activity checks the status of a pool to determine if it is available to accept traffic. Use this activity to determine if a pool you just created is up and running with the proper configuration.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings

- REST message: F5 POOL Management
- REST function: get

Input variables

Check F5 Pool input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>PoolName</td>
<td>Name of this pool, such as testPool.</td>
</tr>
</tbody>
</table>

Output variables

Check F5 Pool output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
</tbody>
</table>
Conditions

Check F5 Pool conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully returned the status of the F5 load balancer pool.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to return the status of the F5 load balancer pool.</td>
</tr>
</tbody>
</table>

Add F5 Profile to Virtual Server activity

The Add F5 Profile to Virtual Server activity adds a profile to a virtual server assigned to an F5 load balancer pool.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings

- **REST message**: F5 VIP Profile Management
- **REST function**: post

Input variables

Add F5 Profile to Virtual Server input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>The virtual server's name, such as testVIP</td>
</tr>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>VirtualServerName</td>
<td>Name of the virtual server, such as testVIP.</td>
</tr>
</tbody>
</table>

Output variables

Add F5 Profile to Virtual Server output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>output</td>
<td>The REST output.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
</tbody>
</table>
Conditions

Add F5 Profile to Virtual Server conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully added the F5 load balancer profile to the virtual server.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to add the F5 load balancer profile to the virtual server.</td>
</tr>
</tbody>
</table>

Modify F5 Virtual Server activity

The Modify F5 Virtual Server activity configures a virtual server assigned to an F5 load balancer pool with irules and a vlan.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings

- **REST message**: F5 VIP Management
- **REST function**: put

Input variables

Modify F5 Virtual Server input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>The virtual server's name, such as testVIP.</td>
</tr>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>irules</td>
<td>The irules for the virtual server, such as _sys_https_redirect.</td>
</tr>
<tr>
<td></td>
<td>• <strong>pool</strong>: Name of the pool for the virtual server, such as testPool.</td>
</tr>
<tr>
<td></td>
<td>• <strong>persistent</strong>: Persistent profile for the virtual server, such as cookie.</td>
</tr>
<tr>
<td>vlans</td>
<td>Vlans for the virtual server, such as internal.</td>
</tr>
</tbody>
</table>
Output variables

Modify F5 Virtual Server output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>output</td>
<td>The REST output.</td>
</tr>
</tbody>
</table>

Conditions

Modify F5 Virtual Server conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully configured a virtual server assigned to an F5 load balancer pool.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to configure a virtual server assigned to an F5 load balancer pool.</td>
</tr>
</tbody>
</table>

Add F5 Virtual Server activity

The Add F5 Virtual Server activity adds a virtual server.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

REST settings

- **REST message**: F5 POOL Membership Management
- **REST function**: post

Input variables

Add F5 Virtual Server input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>The virtual server's name, such as testVIP.</td>
</tr>
<tr>
<td>description</td>
<td>Description of this virtual server.</td>
</tr>
<tr>
<td>ipProtocol</td>
<td>Protocol used for this virtual server, such as tcp.</td>
</tr>
<tr>
<td>destination</td>
<td>Virtual server IP address and port number, such as 192.168.4.20:80.</td>
</tr>
<tr>
<td>mask</td>
<td>Subnet mask for this virtual server, such as 255.255.255.255.</td>
</tr>
</tbody>
</table>
### Variable Description

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>sourceAddressTranslation</td>
<td>Source address translation mode.</td>
</tr>
</tbody>
</table>

### Output variables

**Add F5 Virtual Server output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
<tr>
<td>output</td>
<td>The REST output.</td>
</tr>
</tbody>
</table>

### Conditions

**Add F5 Virtual Server conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully added a virtual server.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to add a virtual server.</td>
</tr>
</tbody>
</table>

### Delete F5 Pool Member activity

The Delete F5 Pool Member activity deletes an F5 load balancer pool member.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Active Directory**.

### REST settings

- **REST message**: F5 POOL Membership Management
- **REST function**: delete

### Input variables

**Delete F5 Pool Member input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PoolName</td>
<td>Name of this pool, such as testPool.</td>
</tr>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
</tbody>
</table>
### Output variables

#### Delete F5 Pool Member output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
</tbody>
</table>

### Conditions

#### Delete F5 Pool Member output variables

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity succeeded in deleting an F5 load balancer pool member.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to delete an F5 load balancer pool member.</td>
</tr>
</tbody>
</table>

### Delete F5 Pool activity

The Delete F5 Pool activity deletes an F5 load balancer pool.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Active Directory.

### REST settings

- **REST message**: F5 POOL Management
- **REST function**: delete

### Input variables

#### Delete F5 Pool input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>PoolName</td>
<td>Name of this pool, such as testPool.</td>
</tr>
</tbody>
</table>
### Output variables

**Delete F5 Pool output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
</tbody>
</table>

### Conditions

**Delete F5 Pool conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully deleted the F5 load balancer pool.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to delete the F5 load balancer pool.</td>
</tr>
</tbody>
</table>

### Add F5 Pool activity

The Add F5 Pool activity creates the F5 load balancer pool. Use this activity to verify that a pool member was created properly.

This activity was built using the REST web service activity template. To access the activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Active Directory**.

### REST settings

- **REST message**: F5 POOL Management
- **REST function**: post

### Input variables

**Add F5 Pool input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PoolName</td>
<td>Name of this pool, such as testPool.</td>
</tr>
<tr>
<td>F5IPAddress</td>
<td>IP address of the F5 console.</td>
</tr>
<tr>
<td>MemberName</td>
<td>Pool member IP address and port, such as 192.168.2.19:80.</td>
</tr>
</tbody>
</table>
Output variables

Add F5 Pool output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Success or failure.</td>
</tr>
<tr>
<td>status_code</td>
<td>The HTTP status code.</td>
</tr>
<tr>
<td>error</td>
<td>The REST error.</td>
</tr>
<tr>
<td>output</td>
<td>The REST output.</td>
</tr>
</tbody>
</table>

Conditions

Add F5 Pool conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity succeeded in creating the F5 load balancer pool.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to create the F5 load balancer pool.</td>
</tr>
</tbody>
</table>

Infoblox DDI activity pack

This activity pack supports Infoblox DDI management through ServiceNow Orchestration.

The Infoblox DDI activity pack manages the IP addresses used in a network by integrating DNS and DHCP. Custom Orchestration activities use Infoblox Web API (WAPI) REST web services to access the Infoblox GRID server.

**Important:** Managing IP addresses through the Infoblox server requires a fully functional MID Server.

Starting with the Jakarta release, the Infoblox activity pack updates to version 2. This update supports Infoblox network views, which can restrict the visibility of network data. The view parameter can be passed as a query parameter or payload content, to do operations in a specific view. Version 2 also supports specifying the version of WAPI to use in integration endpoints.

Supported for Infoblox:

- WAPI version 2.0 for REST messages
- NIOS appliance version 7.0

**Note:** To use the Infoblox DDI activities and workflow, you must request activation of the Orchestration - Infoblox DDI Activity Pack plugin.

Create a REST credential for Infoblox activities

All Infoblox activities require a REST credential to manage IP addresses from the Infoblox DDI server.

Before starting this procedure, make sure you have the following:
• A properly configured and running Infoblox DDI Grid Server.
• REST credentials defined on the Infoblox DDI server.

Role required: admin

You must create a REST credential record on the ServiceNow instance that each Infoblox activity can use to access management features on the Infoblox server.

1. Navigate to **Orchestration > Credentials** and click **New**.
2. In the list of credential types, select **Basic Auth Credentials**.
3. Create the credential record with a logical name, such as **InfobloxCred**.
4. Right-click in the header bar of your new credential record and select **Copy sys_id** from the context menu. Follow browser instructions to copy the sys_id if browser security measures restrict this function.
5. Paste the sys_id into the **restCredentials** input field of each activity you use.

**Infoblox workflows**

The Infobox DDI activity pack includes two default workflows, one that reserves and registers IP addresses and another that releases IP addresses.

To access these workflows, navigate to **Workflow > Workflow Editor** and select the **Workflows** tab. Click on a workflow to open it, and then click the information icon in the workflow header to display the properties dialog box.

**Infoblox Reserve/Register IP in IPAM**

Use this workflow to register IPv4 addresses or request the next available IP address on IPAM. Optionally, you can use it to register IP addresses on DNS. The custom Infoblox activities used in this workflow are:

• IPAM Register IP Address
• IPAM Reserve IP Address
• Register DNS A-Record
• Get Network Details

**Infoblox Reserve/Register IP input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Infoblox Server</td>
<td>IP address of the Infoblox DDI server.</td>
</tr>
<tr>
<td>Network</td>
<td>Network containing the target IP address.</td>
</tr>
<tr>
<td>Zone</td>
<td>The DNS zone for the IP address being registered.</td>
</tr>
<tr>
<td>Rest Credentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>DNS Host Name</td>
<td>Name of the DNS server machine on which the IP address is being registered.</td>
</tr>
<tr>
<td>IPv4 Address</td>
<td>IP address being reserved or registered.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Infoblox Release IPAM Reservations**

Use this workflow to release (delete) all the IPAM reservations associated with an IPv4 address. The custom Infoblox activities used in this workflow are:

- IPAM List IP Reservations
- List DNS Record
- DNS Delete
- IPAM Delete

### Infoblox Release IPAM Reservations input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rest Credentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>IP to Delete</td>
<td>IP address to release.</td>
</tr>
<tr>
<td>Infoblox Server</td>
<td>IP address of the Infoblox DDI server.</td>
</tr>
</tbody>
</table>

### Infoblox roles and permissions

Define the roles and permissions that the Infoblox activities need to access the various resources on the Infoblox server.

#### Admin groups

There are three types of admin groups on an Infoblox server:

- Superuser
- Default
- Limited Access

To perform specific operations on the Infoblox server, the Limited Access user must have a minimum set of privileges for the desired resources, using either the user interface or an API. These privileges are based on read and read/write access. For more information, refer to the "About Admin Groups" section in the Infoblox NIOS Administrator Guide.

### Permission hierarchy

1. **User**: A user can be part of multiple groups.
2. **Group**: A group can have many roles.
3. **Role**: Each role consists of specific resource permissions.

### Required permissions

The ServiceNow Infoblox activity pack requires appropriate read and read/write privileges for these resources:

- Network
• DHCP
• DNS
• IPAM

This example shows a default DHCP admin role, its resources, and the related permissions for each.
Infoblox permissions
**Infoblox DHCP activities**

The Infoblox DHCP activities manage the IP addresses reserved for DHCP in your network.

Use these activities to reserve, list, or delete IP addresses that are used for DHCP assignment in your network.

**DHCP Reserve IP v4 Address Range activity**

The DHCP Reserve IP v4 Address Range activity reserves an IP address range for DHCP use.

The DHCP activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Infoblox DDI > DHCP**.

**Input variables**

**DHCP Reserve IP v4 Address Range input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>startIpAddress</td>
<td>Beginning IPv4 address of the range to reserve.</td>
</tr>
<tr>
<td>endIpAddress</td>
<td>Ending IPv4 address of the range to reserve.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

**Note:** This field is mandatory. If the field is empty, the orchestration activity will fail.

<table>
<thead>
<tr>
<th>variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is default.</td>
</tr>
</tbody>
</table>

**Note:** If the field is empty, the operation is treated as happening in the default view.

**Output variables**

**DHCP Reserve IP v4 Address Range output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCPIPAddressRange</td>
<td>Range of reserved IPv4 addresses.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>
Conditions

**DHCP Reserve IP v4 Address Range conditions**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully reserved the specified IPv4 address range.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to reserve the specified IPv4 address range.</td>
</tr>
</tbody>
</table>

**DHCP Delete IP Reservation activity**
The DHCP Delete IP Reservation activity deletes IP reservations in DHCP using either an IPv4 or IPv6 address range.

An automation can obtain an Infoblox DHCP object to delete from either of these activities:
- DHCP List IP Reservations
- DHCP Reserve IPv4 Address Range

The DHCP activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Infoblox DDI > DHCP**.

Input variables

**DHCP Delete IP Reservation input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>ipToDelete</td>
<td>IP address range to delete, in the form: range/&lt;encrypted code&gt;:&lt;start range&gt;/&lt;end range&gt;/default</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

**Note:** This field is mandatory. If the field is empty, the orchestration activity will fail.
Output variables

**DHCP Delete IP Reservation output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCPDeletedIpRange</td>
<td>Range of deleted IP addresses.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>

Conditions

**DHCP Delete IP Reservation conditions**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully deleted the specified IP address range.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to delete the specified IP address range.</td>
</tr>
</tbody>
</table>

**DHCP List IP Reservations activity**

The DHCP List IP Reservations activity generates a list of all the DHCP range reservations on a specific InfoBlox server.

The DHCP activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > DHCP.

Input variables

**DHCP List IP Reservations input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is <strong>2.0</strong>.</td>
</tr>
</tbody>
</table>

**Note**: This field is mandatory. If field is empty, the orchestration activity will fail.
### Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is <code>default</code>.</td>
</tr>
</tbody>
</table>

**Note:** If the field is empty, the operation is treated as happening with no view and returns the values with data from all views.

### Output variables

**DHCP List IP Reservations output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reference</td>
<td>Reference value for an array of DHCP address ranges in this format: <code>range/&lt;encrypted code&gt;:&lt;start range&gt;/&lt;end range&gt;/default</code></td>
</tr>
<tr>
<td>network</td>
<td>Address of the network containing the IP address range.</td>
</tr>
<tr>
<td>network_view</td>
<td>Routing domain associated with the network returned.</td>
</tr>
</tbody>
</table>

### Conditions

**DHCP List IP Reservations conditions**

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully returned an array of DHCP IP address ranges.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to return an array of DHCP IP address ranges.</td>
</tr>
</tbody>
</table>

### Infoblox DNS activities

The Infoblox DNS activities manage DNS records in your network using an Infoblox DDI Grid Server. Use these activities to register, list, or delete DNS records managed on an Infoblox server.

**List DNS C-records activity**

The List DNS C-records activity retrieves all canonical (CNAME) records from a specified Infoblox server. The DNS activities use the REST web service activity template to manage DNS records using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Infoblox DDI > DNS**.
# Input variables

## List DNS C-records input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is default.</td>
</tr>
</tbody>
</table>

**Note:** This field is mandatory. If field is empty, the orchestration activity will fail.

**Note:** If the field is empty, the operation is treated as happening with no view and returns the values with data from all views.

# Output variables

## List DNS C-records output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
<tr>
<td>reference</td>
<td>Reference value for a DNS CNAME record, such as: record:cname/2G5zLmJpbmRfY25hbWUkLl9kZWZhdWx0LmNvbS50ZXN0Lmh0bWw= default</td>
</tr>
<tr>
<td>canonicalName</td>
<td>CNAME record.</td>
</tr>
<tr>
<td>name</td>
<td>Name of the network option returned, such as domain-name-server.</td>
</tr>
<tr>
<td>view</td>
<td>The assigned view of the DNS data. A given zone can have multiple views, which are accessed depending on the IP address of the source of the query. The default view of DNS data for this activity is the network view.</td>
</tr>
</tbody>
</table>
## Conditions

### List DNS C-records conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully listed the DNS C records.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to list the DNS C records.</td>
</tr>
</tbody>
</table>

### Register DNS A-record activity

The Register DNS A-record activity creates a DNS A record on a specified Infoblox server.

The DNS activities use the REST web service activity template to manage DNS records using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > DNS.

## Input variables

### Register DNS A-record input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>network</td>
<td>Address of the network containing the IP address to register in the record.</td>
</tr>
<tr>
<td>hostName</td>
<td>Name of the actual server machine associate with the IP address in this record.</td>
</tr>
<tr>
<td>zone</td>
<td>The DNS zone associated with the record being created.</td>
</tr>
<tr>
<td>ipAddress</td>
<td>Specific IP address registered in this record.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

**Note:** This field is mandatory. If the field is empty, the orchestration activity will fail.

<table>
<thead>
<tr>
<th>variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is default.</td>
</tr>
</tbody>
</table>

**Note:** If the field is empty, the operation is treated as happening in the default view.
Output variables

Register DNS A-record output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
<tr>
<td>DNSAResult</td>
<td>Name of the record registered, expressed in the format: record:host/&lt;encrypted code&gt;;&lt;network name&gt;/default.</td>
</tr>
</tbody>
</table>

Conditions

Register DNS A-record conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully created the DNS A record.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to create the DNS A record.</td>
</tr>
</tbody>
</table>

Register DNS C-Record activity

The Register DNS C-Record activity creates a DNS canonical (CNAME) record on a specified Infoblox server.

The DNS activities use the REST web service activity template to manage DNS records using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > DNS.

Input variables

Register DNS C-Record input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>cname</td>
<td>The DNS canonical record to create, as expressed by the <em>c_name</em> value.</td>
</tr>
<tr>
<td>recordName</td>
<td>Name of the record to create.</td>
</tr>
<tr>
<td>zone</td>
<td>The DNS zone containing the canonical record to create.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| api_version| Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.  
  Note: This field is mandatory. If the field is empty, the orchestration activity will fail. |
| view       | Name of the Infoblox network view. The default value is default.            
  Note: If the field is empty, the operation is treated as happening in the default view. |

Output variables

Register DNS C-Record output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
<tr>
<td>DNSCRecord</td>
<td>Name of the CNAME record registered, expressed in the format: record:cname/&lt;encrypted code&gt;:&lt;network name&gt;/default.</td>
</tr>
</tbody>
</table>

Conditions

Register DNS C-Record conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully created the canonical DNS record.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to create the canonical DNS record.</td>
</tr>
</tbody>
</table>

List DNS Record activity

The List DNS Record activity generates a list of all the DNS entries on a specific InfoBlox server.

The DNS activities use the REST web service activity template to manage DNS records using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > DNS.
## Input variables

### List DNS Record input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
</tbody>
</table>
| api_version    | Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.  
  **Note**: This field is mandatory. If field is empty, the orchestration activity will fail.  |
| view           | Name of the Infoblox network view. The default value is `default`.           
  **Note**: If the field is empty, the operation is treated as happening with no view and returns the values with data from all views.  |

## Output variables

### List DNS Record output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reference</td>
<td>Reference value for a DNS record, such as: <code>record:cname/ZG5zLmJpbnRfY25hbiWUKlL19kZWWzdWx0LmNvbS50ZXN0LmNlY3Jlc3RyZXRjaC</code> when <code>default</code> is used.</td>
</tr>
<tr>
<td>configure_for_dhcp</td>
<td>Returns the status of a DHCP fixed address object.</td>
</tr>
<tr>
<td>host</td>
<td>Host machine with which the DNS record is associated.</td>
</tr>
<tr>
<td>ipv4addr</td>
<td>The reserved IPv4 address associated with a DNS record.</td>
</tr>
<tr>
<td>name</td>
<td>Name of the network option returned. For example, the name of the DNS record object from the <code>reference</code> example is <code>cname.test.com</code>.</td>
</tr>
<tr>
<td>view</td>
<td>The assigned view of the DNS data. A given zone can have multiple views, which are accessed depending on the IP address of the source of the query. The <code>default</code> view of DNS data for this activity is the network view.</td>
</tr>
</tbody>
</table>
### Conditions

#### List DNS Record conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully listed all the available DNS record.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to list the available DNS record.</td>
</tr>
</tbody>
</table>

#### DNS Delete activity

The DNS Delete activity deletes DNS records of any type from in Infoblox server, such as C and A records.

The DNS activities use the REST web service activity template to manage DNS records using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Infoblox DDI > DNS**.

Note: It is faster to create a new record than recover one that has been deleted.

### Input variables

#### DNS Delete input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>RecordToDelete</td>
<td>Name of the DNS record to delete. The record is expressed in this format:</td>
</tr>
<tr>
<td></td>
<td>record:cname/6G5zLmJpboRFy25hbWUkLl9kZWzdWx0LmNvbS50ZXN0LmNu</td>
</tr>
<tr>
<td></td>
<td>default</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

Note: This field is mandatory. If the field is empty, the orchestration activity will fail.
Output variables

DNS Delete output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DeletedRecord</td>
<td>Name of the deleted DNS record.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>

Conditions

DNS Delete conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully deleted the specified DNS record.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to delete the specified DNS record.</td>
</tr>
</tbody>
</table>

Infoblox IPAM activities

The Infoblox IPAM activities manage IP addresses in your network using an Infoblox DDI Grid Server. Use these activities to register, reserve, list, or delete IP addresses.

**IPAM Register IP Address activity**

The IPAM Register IP Address activity registers an IP address in a network using Infoblox IPAM.

The output of this activity produces an InfoBlox IP address record that can be used for other IPAM functions in the format `fixedaddress/<encrypted key>:<reserved ip address>/<view>`.

The IPAM activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > IPAM.

Input variables

IPAM Register IP Address input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>macAddress</td>
<td>Mac address of the computer for which this IP address is registered.</td>
</tr>
<tr>
<td>ipAddress</td>
<td>Specific IP address to register.</td>
</tr>
<tr>
<td>network</td>
<td>Address of the network containing the registered IP address.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is <em>default</em>.</td>
</tr>
</tbody>
</table>

**Note:** This field is mandatory. If the field is empty, the orchestration activity will fail.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
<tr>
<td>IPAddressRecord</td>
<td>IPAM record of the registered IP address.</td>
</tr>
</tbody>
</table>

**Output variables**

**IPAM Register IP Address output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully registered the specified IP address.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to register the specified IP address.</td>
</tr>
</tbody>
</table>

**Conditions**

**IPAM Register IP Address conditions**

**IPAM Reserve IP Address activity**

The IPAM Reserve IP Address activity reserves an IP address in a network using Infoblox IPAM. The output of this activity produces an InfoBlox IP address record that can be used for other IPAM functions in the format `fixedaddress/<encrypted key>:<reserved ip address>/<view>`. The IPAM activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Infoblox DDI > IPAM**.
## Input variables

**IPAM Reserve IP Address input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>macAddress</td>
<td>Mac address of the computer for which this IP address is reserved.</td>
</tr>
<tr>
<td>network</td>
<td>Address of the network containing the reserved IP address. The Infoblox server reserves the next available IP address from this network.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is mandatory. If the field is empty, the orchestration activity will fail.</td>
</tr>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is default.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the field is empty, the operation is treated as happening in the default view.</td>
</tr>
</tbody>
</table>

## Output variables

**IPAM Reserve IP Address output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
<tr>
<td>IPAddressRecord</td>
<td>IPAM record of the reserved IP address.</td>
</tr>
<tr>
<td>IPAddress</td>
<td>Selected IP address to reserve.</td>
</tr>
</tbody>
</table>

## Conditions

**IPAM Reserve IP Address conditions**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully reserved the specified IP address.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to reserve the specified IP address.</td>
</tr>
</tbody>
</table>

**IPAM List IP Reservations activity**
The IPAM List IP Reservations activity returns an array of all IP Address within the named InfoBlox Server. The IPAM activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > IPAM.

**Input variables**

**IPAM List IP Reservations input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

**Note:** This field is mandatory. If field is empty, the orchestration activity will fail.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>view</td>
<td>Name of the Infoblox network view. The default value is default.</td>
</tr>
</tbody>
</table>

**Note:** If the field is empty, the operation is treated as happening with no view and returns the values with data from all views.

**Output variables**

The output of this activity produces an array of reserved IP addresses in the format fixedaddress/<encrypted key>:<reserved ip address>/<view>.

**IPAM List IP Reservations output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reference</td>
<td>Reference value of a reserved IP address contained in an array of addresses, such as fixedaddress/0908G0G0G0G0G0:0.0.0.11</td>
</tr>
<tr>
<td>ipv4addr</td>
<td>The reserved IPv4 address.</td>
</tr>
</tbody>
</table>
### Conditions

**IPAM List IP Reservations conditions**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved the list of reserved IP addresses from the Infoblox server.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve the list of reserved IP addresses from the Infoblox server.</td>
</tr>
</tbody>
</table>

**IPAM Delete activity**
The IPAM Delete activity deletes an IP Address within a named Infoblox server.

The IPAM activities use the REST web service activity template to manage IP addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > IPAM.

### Input variables

**IPAM Delete input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>itemToDelete</td>
<td>The IP address to delete, in the format <code>fixedaddress/&lt;encrypted key&gt;:&lt;reserved ip address&gt;/&lt;view&gt;</code>.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The <code>sys_id</code> of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is <code>2.0</code>.</td>
</tr>
</tbody>
</table>

**Note:** This field is mandatory. If the field is empty, the orchestration activity will fail.
Output variables

**IPAM Delete output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DeletedRecord</td>
<td>IPAM record of the deleted IP address.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>

Conditions

**IPAM Delete conditions**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully deleted the specified IP address.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to delete the specified IP address.</td>
</tr>
</tbody>
</table>

Infoblox network activities

The Infoblox network activities manage networks using an Infoblox DDI Grid Server.

Use these activities to create, list, or delete networks on an Infoblox server.

*Create Network activity*

The Create Network activity creates new networks on a specified Infoblox server.

The network activities use the [REST web service activity template](#) to manage network addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Infoblox DDI > Network.**

Input variables

**Create Network input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>network</td>
<td>Address of the network to create.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is <strong>2.0</strong>.</td>
</tr>
</tbody>
</table>

**Note:** This field is mandatory. If the field is empty, the orchestration activity will fail.
Variable | Description
---|---
view | Name of the Infoblox network view. The default value is default.

**Note:** If the field is empty, the operation is treated as happening in the default view.

### Output variables

**Create Network output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NetworkCreated</td>
<td>Address of the network created.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>

### Conditions

**Create Network conditions**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully created the network.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to create the network.</td>
</tr>
</tbody>
</table>

**Get Network Details activity**

The Get Network Details activity retrieves the information about a specific network on an Infoblox server.

The network activities use the **REST web service activity template** to manage network addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Infoblox DDI > Network**.

### Input variables

**Get Network Details input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>network</td>
<td>Address of the network whose details you want to see.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
</tbody>
</table>
### Output variables

The output variables from this activity are objects on the Infoblox server used to identify network details. For more information, refer to the Infoblox documentation.

#### Get Network Details output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
<tr>
<td>NetworkOptions</td>
<td>The <strong>NetworkOptions</strong> array contains these attributes:</td>
</tr>
<tr>
<td></td>
<td>• reference: Reference value for the network requested. This value is in the form of <code>network/ZG5zLm5ldHdvcmshMTAuMS4wLjAvMTYvMA:10.1.0.0%2F1</code>.</td>
</tr>
<tr>
<td></td>
<td>• options: The <strong>options</strong> array contains these attributes:</td>
</tr>
<tr>
<td></td>
<td>• name: Name of the network option returned, such as <strong>domain-name-server</strong>.</td>
</tr>
<tr>
<td></td>
<td>• num: Index number of the option. For example, the index for <strong>domain-name-server</strong> is <strong>6</strong>.</td>
</tr>
<tr>
<td></td>
<td>• use_option: Indicates whether a DHCP option is used at that level in the network hierarchy. Set this value to <strong>True</strong> to override the Grid Level DHCP option with this option at the network level.</td>
</tr>
<tr>
<td></td>
<td>• value: Value to use for this option. For example, the value for the <strong>domain-name-server</strong> option is the IP address of the server machine.</td>
</tr>
<tr>
<td></td>
<td>• vendor_class: The class of the network object. The options are <strong>DHCP</strong>, <strong>DNS</strong>, or <strong>IPAM</strong>.</td>
</tr>
</tbody>
</table>
Conditions

Get Network Details conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved network details from the Infoblox server.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve network details from the Infoblox server.</td>
</tr>
</tbody>
</table>

Delete Network activity

The Delete Network activity deletes a network from an Infoblox server.

The network activities use the REST web service activity template to manage network addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > Network.

Input variables

Delete Network input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>networkToDelete</td>
<td>Reference number of the network to delete from the Infoblox server. You can obtain this value either by using the List Registered Networks activity or when creating a network with the Create Network activity. An example of the network reference value is: network/ZG5zLm5IdHdvcmskMTUuMC40NS4wLzI0LzA:15.0.45.0/24/default.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

Note: This field is mandatory. If the field is empty, the orchestration activity will fail.
Output variables

Delete Network output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DeletedNetwork</td>
<td>Reference number of the deleted network from the Infoblox server.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>

Conditions

Delete Network conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully deleted the network.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to delete the network.</td>
</tr>
</tbody>
</table>

List Registered Networks activity

The List Registered Networks activity retrieves all the networks associated with an Infoblox server.

The network activities use the REST web service activity template to manage network addresses using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST capabilities.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Infoblox DDI > Network.

Input variables

Activity input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfobloxServer</td>
<td>Name of the Infoblox DDI Grid Server.</td>
</tr>
<tr>
<td>restCredentials</td>
<td>The sys_id of the REST credentials from the ServiceNow instance.</td>
</tr>
<tr>
<td>api_version</td>
<td>Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.</td>
</tr>
</tbody>
</table>

Note: This field is mandatory. If field is empty, the orchestration activity will fail.
### Output variables

#### Activity output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reference</td>
<td>Reference value of a registered network.</td>
</tr>
<tr>
<td>network</td>
<td>Network address.</td>
</tr>
<tr>
<td>network_view</td>
<td>Routing domain associated with the network returned.</td>
</tr>
<tr>
<td>error</td>
<td>Displays the message for any REST error encountered.</td>
</tr>
</tbody>
</table>

### Conditions

#### Activity conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved the list of registered networks available on the Infoblox server.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve the list of registered networks available on the Infoblox server.</td>
</tr>
</tbody>
</table>

### PowerShell activity pack

PowerShell is built on the Windows .NET Framework and is designed to control and automate the administration of Windows machines and applications.

Orchestration provides custom PowerShell activities that were created with the PowerShell activity designer template. These activities perform the same functions as PowerShell activities by the same name from previous releases and replace those activities for all new workflows. These custom activities give workflow administrators the ability to store input and output variables in the databus.

**Note:** Existing workflows from earlier versions that were created with legacy PowerShell activities continue to function normally after an upgrade to Geneva. However, all new workflows must use these custom PowerShell activities.

Starting with the New York release, there are the following updates to the PowerShell activity pack:

- [Variable](#variable)
- [Description](#description)
- [Note](#note)

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
- A new PowerShell probe (V2), which takes advantage of IntegrationHub functionality
- The ability to insert debug statements in the PowerShell scripts and produce the resulting messages at runtime

To use the PowerShell custom activities, you must request activation of the Orchestration - PowerShell plugin. These activities are available in the Workflow Editor on the Custom tab. Expand the Custom Activities tree and select the PowerShell category for the activity you want to use.

ServiceNow supports PowerShell 2.0 and above. PowerShell 3.0 does not support Windows 2003 Server.

**PowerShell activity designer**

PowerShell activities are configured to return data to a workflow from a host using Microsoft PowerShell.

You must purchase Orchestration to use this template. For specific information about using the tools in the activity designer, refer to these resources:

- Orchestration activity designer
- Create input variables
- Create a parsing rule

ServiceNow supports PowerShell 2.0 and above. PowerShell 3.0 does not support Windows 2003 Server.

**PowerShell protocols and troubleshooting**

PowerShell uses the Windows Management Instrumentation (WMI) and Windows Remote Management (WinRM) protocols to enable Orchestration activities to run commands on remote Windows hosts.

**Windows Management Instrumentation (WMI)**

WMI provides a uniform interface for any local or remote applications or scripts that obtain management data from a computer system, a network, or an enterprise. WMI contains these components:

- **Managed objects and WMI providers**: A WMI provider is a COM object that monitors one or more managed objects for WMI. A managed object is a logical or physical enterprise component, such as a hard disk drive, network adapter, database system, operating system, process, or service.
- **WMI infrastructure**: The WMI infrastructure is a Microsoft Windows operating system component known as the WMI service (winmgmt). The WMI infrastructure is composed of the WMI Core and the WMI repository. The WMI repository is organized by WMI namespaces. The WMI service creates namespaces, such as root\default, root\cimv2, and root\subscription, at system startup and preinstalls a default set of class definitions, including the Win32 Classes, the WMI System Classes, and others. The remaining namespaces found on your system are created by providers for other parts of the operating system or products.
- **WMI consumers**: A WMI consumer is a management application or script that interacts with the WMI infrastructure. A management application can query, enumerate data, run provider methods, or subscribe to events by calling either the COM API or the Scripting API for WMI.

**WMI installation and configuration**

For the MID Server to successfully make a remote connection to the target host, TCP port 135 must be open. The Windows firewall automatically creates an inbound rule for WMI connectivity called Windows Management Instrumentation (DCOM-In).
Windows Remote Management (WinRM)

WinRM is the Microsoft implementation of WS-Management Protocol, a standard Simple Object Access Protocol (SOAP) protocol that allows hardware and operating systems from different vendors to interoperate.

WinRM contains these components:

- **WinRM Scripting API**: This scripting API enables Orchestration to obtain data from remote computers, using scripts that perform WS-Management protocol operations.
- **WMI Service**: The WMI service continues to run side-by-side with WinRM and provides requested data or control through the WMI plug-in. You can continue to obtain data from standard WMI classes, such as Win32_Process.

WinRM configuration

WinRM is automatically installed on Windows 2008 R2 and above operating systems, but must be configured before use.

1. In a command prompt, enter `winrm quickconfig`. This command is not case sensitive.
2. When the console displays **Make these changes [y/n]?**, enter `y`.
   
   The `winrm quickconfig` command performs the following operations:
   
   - Starts the WinRM service, and sets the service startup type to **auto start**.
   - Configures a listener for the ports that send and receive WS-Management protocol, using either HTTP or HTTPS on any IP address.
   - Creates a firewall exception for the current user profile.

MID Server PowerShell files

PowerShell functions are stored in script files (*.ps1) that use a PowerShell Script module (*.psm1) file name extension.

The PowerShell functions are used by the PowerShell MID Server script files included in these activity packs:

- Active Directory
- Exchange
- SCCM
- PowerShell

PSScript.ps1

This script performs a few tasks, such as credential testing, password encryption, and the execution of scripts configured in the Orchestration Activity Designer or in MID Script Files. However, this document focuses on how PSScript.ps1 uses the `credential.psm1` module for testing access to remote hosts.

The PowerShell variables are generally used directly in the **PowerShell execution command** or as arguments in the MID Server script file you specify. There are special variables that are passed to PSScript.ps1, such as `credType`. 
Using credType in execution parameters
PowerShell credTypes

The PowerShell credential types:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WMI</td>
<td>testCredentialWMI</td>
</tr>
<tr>
<td>Exchange</td>
<td>testCredentialExchange</td>
</tr>
<tr>
<td>AD</td>
<td>testCredentialAD</td>
</tr>
<tr>
<td>SCCM</td>
<td>testCredentialSCCM</td>
</tr>
</tbody>
</table>

If no credential type is passed to the PSScrip.ps1 script, the MID Server defaults to the WMI test function to test access to the target host. If there is a credential type used, the MID Server runs the corresponding test function for that credential type.

Exit codes

These exit codes are returned from the PSScript.ps1 script and logged in the MID Server log file.

<table>
<thead>
<tr>
<th>PSScript.ps1 exit codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>0</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
</tbody>
</table>

DiagnosticsUtil.psm1

The MID Server uses this module file to perform PowerShell logging that assists debugging any Orchestration activity using PowerShell scripting. You can also add debugging statements directly to custom scripts.
### PowerShell diagnostic utilities

<table>
<thead>
<tr>
<th>Utility</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNCLog-DebugInfo</td>
<td>Log a debug message for a PowerShell script or PowerShell Orchestration activity. Examples:</td>
</tr>
<tr>
<td></td>
<td>• SNCLog-DebugInfo -message &quot;My debug message...&quot;</td>
</tr>
<tr>
<td></td>
<td>• SNCLog-DebugInfo &quot;My debug message&quot;</td>
</tr>
<tr>
<td>SNCLog-ParameterInfo</td>
<td>Log a function parameter value. For &quot;function getHostName{ param( [String] $target )}&quot;, the first value to the PowerShell hashtable is a string to indicate which function executes, and the values for each of the function parameters. Examples:</td>
</tr>
<tr>
<td></td>
<td>• Function with single parameter: SNCLog-ParameterInfo @(&quot;Running getHostName&quot;, $target)</td>
</tr>
<tr>
<td></td>
<td><img src="https://example.com" alt="Note:" /> The debug message shows,</td>
</tr>
<tr>
<td></td>
<td>'Running getHostName $target:[actual value of $target]'.</td>
</tr>
<tr>
<td></td>
<td>• Function with multiple parameters: SNCLog-ParameterInfo @(&quot;Running functionName&quot;, $param1, $param2, $param3)</td>
</tr>
<tr>
<td>SNCObfuscate-Value</td>
<td>Use this utility to encrypt values for security purposes. The function displays &quot;$variableName&quot;:***, where *** is the obfuscated value. Example:</td>
</tr>
<tr>
<td></td>
<td>• SNCObfuscate-Value $password</td>
</tr>
<tr>
<td></td>
<td><img src="https://example.com" alt="Note:" /> The debug message reads:</td>
</tr>
<tr>
<td></td>
<td>&quot;$password : ***&quot;.</td>
</tr>
</tbody>
</table>

### Credentials.psm1

The MID Server uses this module file to test access to a target host. The MID Server loops through all Windows credentials stored in its credentials table using the following access type functions, unless the PowerShell activity has a credential type (credType) defined. All ServiceNow® authored PowerShell activities are hard-coded to use a specific credential type. As a result, the MID Server only tests credential access against the designated function.
## PowerShell test functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>testCredentialWMI</td>
<td>Tests the given user and password on the target host using the <strong>Get-WMI</strong> object.</td>
</tr>
<tr>
<td>testCredentialAD</td>
<td>Tests the given user and password on the target host using the built-in <strong>DirectoryEntry</strong> object.</td>
</tr>
<tr>
<td>testCredentialExchange</td>
<td>Tests the given user and password to create a session on an Exchange host. This test uses the built-in PowerShell remoting feature on a remote host. WinRM is configured on Exchange servers by default.</td>
</tr>
<tr>
<td>testCredentialSCCM</td>
<td>Tests the given user and password to create a session on an SCCM server. This test uses the built-in PowerShell remoting feature on a remote host. This test requires WinRM to be configured.</td>
</tr>
<tr>
<td>testNoCredentialAccessWMI</td>
<td>Tests the given user and password on the target host, using the <strong>Get-WMI</strong> object. This test is used when no credType is used.</td>
</tr>
</tbody>
</table>

**Note:** If the test passes using one of these functions, that credential is used to run the PowerShell script/command. If the tests fail to access the target host using these functions, the MID Server runs the PowerShell script/command under the account of the MID Server service.

This diagram illustrates the dependency of the credential selection behavior on the host being targeted by the PowerShell activity. If the target host is the IP address or host name of the MID Server, the MID Server bypasses all credentials in the Credentials table and uses the account of the MID Server service. If the target host is not the MID Server, then all Windows credentials are used first. If all credentials in the Credentials table are unsuccessful in running the PowerShell activity, then the MID Server uses the MID Server service account.
PowerShell credential selection criteria
ActiveDirectory.psm1

This module file stores the functions used by the PowerShell scripts shipped with the Active Directory activity pack.

Exchange.psm1

This module file stores the functions used by the PowerShell scripts shipped with the Exchange activity pack.

SCCM.psm1

This module file stores the functions used by the PowerShell scripts shipped with the SCCM activity pack.

Set up credential tags for a PowerShell activity
Credential tagging gives an administrator more control over the credentials used in a PowerShell activity.

Role required: admin, activity_creator or workflow_admin

Tagging is useful when the activity requires specific credentials to perform a task. By populating the Credential tag field you are telling the activity to use a credential that has a specific tag set for it. Additionally, credential tagging allows you to use a different underlying credential in development, testing, and production systems without having to change the activity for a given target system. For example, you can use the SCCM:Cred tag and have it point to both a development and test instance.

1. Navigate to Orchestration > Credentials.
2. Select the credential you want to tag.
3. Enter a unique name in the **Tag** field that is descriptive of the credentials purpose.

4. Click **Update**.

5. Open the Workflow Editor and select the PowerShell activity you want to tag.
6. In the activity's Execution Command, add the name of the tag you created to the **Credential tag** field.
**PowerShell troubleshooting**

Authentication and access denied errors can prevent PowerShell activities from running a command on a target host.

Use these procedures for troubleshooting authentication failures with Orchestration PowerShell activities and when the Remote Procedure Call (RPC) server is unavailable or when access is denied. The authentication failure error displays when all credentials, including those of the local MID Server service account, do not have the correct permissions to run the Powershell script/command. The same error displays when the target host is unreachable.

**Response**

```
Authentication failure with the local MID server service credential.
```

**Authentication error message**

Authentication failure in an Active Directory activity

This example uses the Create AD Object activity to illustrate troubleshooting authentication failure in PowerShell.

Role required: Permissions to access and create accounts on Active Directory

Validate that the account you are using has the proper permissions to run the activity.

1. Log on to the target machine using the account under which you want to run the activity.
   Active Directory tools must be installed on this machine.
2. Launch the Active Directory Users and Computers application.
3. Navigate to the OU under which you want to create the Active Directory object.
4. Attempt to create the object.

   If this procedure is successful under the specified user, the following might be the cause of the authentication failure:
   - User name is invalid.
   - Password entered incorrectly.
   - Domain controller is unreachable.

**Note:** The majority of the return codes listed in the MID Server log for this error are 1s and 3s. This is because the Active Directory activities use the ADSI provider and not WMI or WinRM. An error code of 1 means the account was able to connect with the test account, but running the script failed.
An error code of 3 means that the MID Server attempted to run the PowerShell activity under the MID Server service account but failed.

Authentication failure in an Exchange activity

This example uses the Create Mailbox activity to illustrate troubleshooting authentication failure in PowerShell.

Role required: Permissions to access and create mailboxes on the Exchange server

1. Validate that the account you are using has the proper permissions to run the PowerShell activity.
2. Log on to a machine that has the Exchange Management Shell (EMS) installed.
3. Create a user using the `New-mailbox` Exchange commandlet.

   ```powershell
   New-Mailbox -Name 'Test F. Smith' -Alias 'test.smith' -OrganizationalUnit 'disclab@service-now.com/Managed Objects/Users/San Diego' -UserPrincipalName 'test.smith@disclab2.service-now.com' -SamAccountName 'test.smith' -FirstName 'Test' -Initials 'T' -LastName 'Smith' -Password (Get-PSDrive System).Security.SecureString $Password -ResetPasswordOnNextLogon $false
   ```

Creating a new user in Exchange

If this procedure is successful under the specified credential, the following is the likely cause of the failure:

- User name is invalid.
- Password entered incorrectly.
- Exchange server is unreachable.

4. If the Exchange server is unreachable, examine the MID Server logs.

   Because the Exchange activities use WinRM to access the Exchange server, the logs can provide more troubleshooting information.

   **Note:** Ensure that the error is NOT `WinRM cannot process the request`.

Remote Procedure Call (RPC) server unavailable or access denied

Typically, this error is logged when running a PowerShell script/command that uses WinRM or WMI.

**Possible causes of error**

The target host might have one of these issues:

- WinRM isn’t configured.
- Firewall is blocking access to the host over TCP port 135 (WMI) or HTTP/HTTPS and TCP port 5985 (WinRM).
- Kerberos issue, caused by hopping to multiple hosts using WMI.
Example WinRM error

The Create Mailbox activity from the Exchange activity pack has generated an error in the ECC queue involving authentication using the MID Server service credential. This occurred because the MID Server credential is the last to be used if the targeted host is not the MID Server.

Authentication failure error message

The MID Server log shows that the MID Server tried to run the activity under specific credentials, but wasn’t successful and received an exit code of 1.

```
ATTEMPTING TO USE CREDENTIAL WITH USERNAME 'SERVICE-NOW\JOEL.ZAMALLOA'
Running command: c:\windows\system32\windowspowershell\v1.0\powershell.exe -executionpolicy bypass \"powershell\ps\script.ps1\" -computer \"10.11.129.140\" -script \"c:\users\joel.zamalloa.ad\desktop\\"x.ps1\" -usecred $true -isdiscovery $false -debug $true; exit $LASTEXITCODE"
Thread name is: Powershell is executing...

Gobbled: [10.11.129.140] connecting to remote server failed with the following error mess.
Gobbled: sage: The WinRM client cannot process the request. Default authentication may not be used with an IP address under the following conditions: the transport is HTTPS, or the destination is in the TrustedHosts list, and explicit credentials are not provided. Use winrmcmd to configure TrustedHosts. Note that computers in the TrustedHosts list might not be authenticated. For more information on how to set the trusted hosts list, run the following command: winrm help config. For more information on setting the trusted hosts list see about_Remote_Troubleshooting Help topic.
Gobbled: on, see the about_Remote_Troubleshooting Help topic.
Gobbled: + CategoryInfo : OpenError: (System.Manage.....RemoteRunspace:Re
Gobbled: moteRunspace) [], PSSharingTransportException
Gobbled: + FullyQualifiedErrorId: PSSessionOpenFailed

The exit value from waitFor() is 1
The status code returned from running the command is 1
Windows credentials all failed... Attempting to use the credential from the local MID server.
```
Join Domain activity

The Join Domain activity joins a Windows computer to a domain.

If the computer is already a member of a domain, this activity completes without modifying the computer.

Joining a domain requires a username and password. This user must have domain administration privileges or privileges to join a computer to the domain.

Note: This activity replaces a Powershell activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Join Domain input variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Hostname or IP address of the Windows server that is joining the domain.</td>
</tr>
<tr>
<td>Domain</td>
<td>Name of the domain to join.</td>
</tr>
<tr>
<td>Domain_user</td>
<td>The name of a user who has domain administration privileges or privileges to join a computer to the domain.</td>
</tr>
<tr>
<td>Domain_user_password</td>
<td>The password for the user who has domain administration privileges or privileges to join a computer to the domain.</td>
</tr>
</tbody>
</table>

Output variables

Join Domain output variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
</tbody>
</table>
Conditions

Join Domain conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in joining the computer to the domain.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to join the computer to the domain.</td>
</tr>
</tbody>
</table>

Install Windows App activity

The Install Windows App activity installs an application from an MSI package on a Windows target machine.

**Note:** This activity replaces a Powershell activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the PowerShell activity designer, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Install Windows App input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>Hostname or IP address of the target Windows machine on which the service is installed. Use the Resolve DNS MID Server capability to resolve hostnames into IP addresses.</td>
</tr>
<tr>
<td>installerpath</td>
<td>Path to the installer. The installer can be on any machine that is visible to both the MID Server and the target machine (local drive, UNC path, mapped drive, etc.).</td>
</tr>
<tr>
<td>installer</td>
<td>Name of the installer file, such as winzip150.msi. The installer must be an MSI package.</td>
</tr>
<tr>
<td>arguments</td>
<td>The parameter that contains the command line arguments to the MSI package. These are name=value pairs, separated by a space. For example, the argument might appear as: INSTALLDIR=c:\myinstallfolder ADDDESKTOPICON=0. These arguments are dependent on what the actual MSI being installed defines. If there are no arguments, leave the field empty.</td>
</tr>
</tbody>
</table>
Output variables

Install Windows App output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

Conditions

The activity state tells the workflow engine what to do with the activity.

Install Windows App conditions

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The Windows application was successfully installed on the target machine.</td>
</tr>
<tr>
<td>Failure</td>
<td>The Windows application failed to install on the target machine</td>
</tr>
</tbody>
</table>

Enable WMI Windows Installer provider

To install software on Windows machines using the Install Windows App activity, enable WMI Windows Installer provider on all target machines.

- It is recommended that the MID Server, the target machine, and the installer source machine be on the same Active Directory domain. However, if these computers are on separate domains, those domains must have a trust relationship established between them.
- If the installer path is a UNC file sharing machine, the Active Directory account of the target computer must be trusted for delegation. For instructions on this configuration, see the posting on the community for installing and uninstalling Windows applications.

Note: See WMI Providers for a list of Windows operating systems that provide this tool by default.

1. Open the Control Panel.
2. Go to Add or Remove Programs.
3. Select Add/Remove Windows Components.
   This action opens a secondary window displaying additional selections.
5. Select WMI Windows Installer Provider check box.
6. Click OK to return to the Windows Components Wizard window.
7. Click Next.
   You might be asked for the Windows installation CD to complete this process.

Change Service State activity

The Change Service State activity starts or stops a Windows service on a remote system.
This activity replaces a Powershell activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the Powershell activity template, which gives workflow administrators the ability to store input and output variables in the databus.

Input Variables

**Change Service State input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>Hostname or IP address of the target Windows machine on which the service is installed. Use the Resolve DNS activity to resolve hostnames into IP addresses.</td>
</tr>
<tr>
<td>service</td>
<td>Name of the Windows service to start or stop. The <code>service</code> parameter is the service name, not the display name of the service affected.</td>
</tr>
<tr>
<td>state</td>
<td>There are two actions to select for a service state change: <code>StartService</code> or <code>StopService</code>.</td>
</tr>
</tbody>
</table>

Output variables

**Change Service State output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources. If there is no error, this value is null.</td>
</tr>
</tbody>
</table>

Conditions

**Change Service State conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The target service was successfully started or stopped.</td>
</tr>
<tr>
<td>Failure</td>
<td>The update to the target service was unsuccessful, or the service was not found on the target system.</td>
</tr>
</tbody>
</table>

Restart Windows Server activity

The Restart Windows Server activity stops and then restarts a Windows server using Powershell.
**Note:** This activity replaces a Powershell activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the Powershell activity template, which gives workflow administrators the ability to store input and output variables in the databus.

### Input variables

**Restart Windows Server input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Hostname or IP address of the Windows server to restart.</td>
</tr>
</tbody>
</table>

### Output variables

**Restart Windows Server output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
</tbody>
</table>

### Conditions

**Restart Windows Server conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in restarting the Windows server.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to restart the Windows server.</td>
</tr>
</tbody>
</table>

### Uninstall Windows App activity

The Uninstall Windows App activity uninstalls an application from a Windows target machine.

The only applications that can be uninstalled using this activity are those that were installed by a Windows Installer.

**Note:** This activity replaces a Powershell activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the Powershell activity template.
template, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Uninstall Windows App input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>Hostname or IP address of the Windows target machine on which to uninstall an application.</td>
</tr>
<tr>
<td>product</td>
<td>The name of the application to uninstall exactly as it appears in the Windows Add/Remove Programs list.</td>
</tr>
</tbody>
</table>

Output variables

Uninstall Windows App output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
</tbody>
</table>

Conditions

Uninstall Windows App conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in unistalling the application from the Windows server.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to uninstall the application from the Windows server.</td>
</tr>
</tbody>
</table>

Probe activity pack

Orchestration provides an activity pack customized using the ServiceNow activity designer that runs probes on target hosts to return specific information.

These custom activities were built with the Create a probe activity, which gives workflow administrators the ability to store input and output variables in the databus.

To use the custom probe activities, you must request activation of the Orchestration - Probe plugin.
Resolve DNS Name activity

The Resolve DNS Name activity takes an IP address or a fully qualified domain name (FQDN), which it resolves into one or more IP addresses.

The domain name is sent through the MID Server to the domain name system (DNS) to resolve the name. If a single IP address is returned, it is stored in two variables: `resolved_ip` and `resolved_ips`. If multiple IP addresses are returned, the first IP address is stored in the `resolved_ip` variable, and all the addresses are stored in the `resolved_ips` variable. If an IP address is provided instead of an FQDN, this address is output directly to both variables. Your ServiceNow instance must have access to a MID Server configured to use Resolve DNS to run this activity.

This activity replaces an activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the Probe activity template, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

### Resolve DNS Name input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FQDN</td>
<td>The fully qualified domain name to resolve or an IP address.</td>
</tr>
</tbody>
</table>

Output variables

### Resolve DNS Name output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ip</td>
<td>The first IP address of the resolved DNS name.</td>
</tr>
<tr>
<td>ips</td>
<td>Comma separated list of resolved IP addresses.</td>
</tr>
<tr>
<td>result</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>resolved</strong>: Able to resolve the specified DNS name.</td>
</tr>
<tr>
<td></td>
<td>• <strong>unresolved</strong>: Unable to resolve the specified DNS name.</td>
</tr>
</tbody>
</table>

Conditions

### Resolve DNS Name conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully resolved the DNS name.</td>
</tr>
</tbody>
</table>
SNMP Query activity

The SNMP Query activity queries an SNMP device.

Your ServiceNow instance must have access to a MID Server configured to use SNMP to run this activity. This activity replaces an activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the Probe activity template, which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

SNMP Query input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>Hostname or IP address of the SNMP device being queried.</td>
</tr>
<tr>
<td>oids</td>
<td>A list of unique object identifiers used to identify SNMP devices.</td>
</tr>
</tbody>
</table>

Output variables

SNMP Query output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>description</td>
<td>Description of the SNMP object.</td>
</tr>
<tr>
<td>timeout</td>
<td>Boolean value indicating whether or not the query timed out.</td>
</tr>
<tr>
<td>error</td>
<td>Indicates any error that occurred. If no error occurred, this value is null.</td>
</tr>
<tr>
<td>oid_data</td>
<td>An array of data objects for all unique object identifiers.</td>
</tr>
</tbody>
</table>

Conditions

SNMP Query conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully ran the query on the target device.</td>
</tr>
</tbody>
</table>
### SCCM activity pack

The Microsoft System Center Configuration Management (SCCM) activity pack provides Orchestration activities you can use to manage software deployments and collections on an SCCM server.

You can use SCCM Orchestration activities to deploy and revoke software from an SCCM server or manage user and device collections. The system manages software on an SCCM server using Orchestration activities and workflows.

Client software distribution requires:
- SCCM 2012 R2 and later.
- Powershell 3.x.
- Powershell Remoting enabled.
- The Windows PowerShell x86 execution policy must be set to unrestricted mode.
- Latest version of the SCCM cmdlet library installed on the SCCM server.
- Use the credentials to log onto the SCCM Server and connect via Windows PowerShell from the System Center Configuration Manager console at least once to set the path variable for that credential.

### Request SCCM activities

The Orchestration - System Center Configuration Manager plugin installs the SCCM activity pack that deploys software from an SCCM host and manages user and device collections.

Role required: admin

The SCCM plugin is activated automatically when the Orchestration - Client Software Distribution [com.snc.orchestration.sccm_mgnt] plugin is activated, but can be activated separately.

**Note:** The activities in the SCCM plugin run in the System Center Configuration Manager scope.

1. Navigate to **System Applications > All Available Applications > All.**
2. On the All Applications page, click **Request Plugin** to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.

<table>
<thead>
<tr>
<th>Activate Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>In order to enhance the user experience, we have redesigned Activate a Plugin service catalog. Please use the new HI Service Portal ‘Activate a Plugin’ service catalog item. You can also use Manage Instances page on Service Portal to Activate a Plugin.</td>
</tr>
<tr>
<td>Take me to the HI Service Portal Activate a Plugin Service Catalog.</td>
</tr>
</tbody>
</table>

4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click Submit.

**Configure the MID Server for SCCM activities**

To use a MID Server with Microsoft System Center Configuration Management (SCCM) activities, configure it to communicate with the SCCM server.

Role required: admin

1. In the navigation filter, enter `cmdb_ci_dns_name.list`.
2. Click New.
3. Enter the fully-qualified domain name (FQDN) of the SCCM server in the **Name** field.
4. Right-click in the form header and select Save.
5. In the **IP Address** related list, click New.
6. In the **IP Address** field, enter the IP address of the SCCM server.
7. In the **Nic** field, select `eth0` or your preferred network interface controller.
8. Leave the **Netmask** field blank.
9. Click Submit.

Add to Device Collection activity

The Add to Device Collection activity adds the specified device into a Microsoft System Center Configuration Manager (SCCM) device collection.

The Add to Device Collection activity uses the Powershell activity template to add a specified device to an SCCM device collection. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called AddToDeviceCollection.ps1 to edit the collection.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > System Center Configuration Manager (SCCM).

![Note: The Add to Device Collection activity does not use pre-processing or post processing scripts.]

Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
<tr>
<td>collection</td>
<td>Name of the device collection.</td>
</tr>
<tr>
<td>device</td>
<td>Name of the device to add to the collection.</td>
</tr>
</tbody>
</table>

Output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>output</td>
<td>Variable that contains a value that is passed to other activities in the workflow.</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

Conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully added the device to the SCCM device collection.</td>
</tr>
<tr>
<td>Condition</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to add the device to the SCCM device collection.</td>
</tr>
</tbody>
</table>

## Add to User Collection activity

The Add to User Collection activity adds a user to a Microsoft System Center Configuration Manager (SCCM) user collection.

The Add to User Collection activity uses the Powershell activity template to access the SCCM server. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called AddToUserCollection.ps1 to edit the collection.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > System Center Configuration Manager (SCCM)**.

**Note:** The Add to User Collection activity does not use pre-processing or post processing scripts.

### Input variables

Add to User Collection input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
<tr>
<td>collection</td>
<td>Name of the user collection.</td>
</tr>
<tr>
<td>user</td>
<td>Name of the user to add to the collection.</td>
</tr>
</tbody>
</table>

### Output variable

Add to User Collection output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>output</td>
<td>Variable that contains a value that is passed to other activities in the workflow.</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

### Conditions

Add to User Collection conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully added a user to the SCCM user collection.</td>
</tr>
</tbody>
</table>
Failure | Activity failed to add a user to the SCCM user collection.

Get Applications activity

The Get Applications activity returns a list of all the applications available on a Microsoft System Center Configuration Manager (SCCM) server.

The Get Applications activity uses the Powershell activity template to access the applications on the SCCM server. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called `GetApplications.ps1`. This script filters the results of the GET, so that only specific attributes are returned for the applications on the SCCM server. Filtering the results in this manner controls the size of the payload, while providing the most desirable application data. The list of available applications is returned as an array in a JSON object.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > System Center Configuration Manager (SCCM).

**Note:** The Get Applications activity does not use a pre-processing script.

Input variables

Get Applications input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
</tbody>
</table>

Output variables

The output variables for the Get Applications activity contain an array of objects called `applications` and an error message. Each object in the array contains the attributes in this table.
Get Applications output variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>applications</td>
<td>The <strong>applications</strong> array contains these attributes:</td>
</tr>
<tr>
<td></td>
<td>• id: Primary key of the SCCM application.</td>
</tr>
<tr>
<td></td>
<td>• ciUniqueId: Unique ID of the SCCM application.</td>
</tr>
<tr>
<td></td>
<td>• name: Name of the application.</td>
</tr>
<tr>
<td></td>
<td>• manufacturer: Manufacturer of the application.</td>
</tr>
<tr>
<td></td>
<td>• version: Version of the application.</td>
</tr>
<tr>
<td></td>
<td>• isDeployable: True/false value indicating if this application is deployable.</td>
</tr>
<tr>
<td></td>
<td>• isDeployed: True/false value indicating if this application is already deployed.</td>
</tr>
<tr>
<td></td>
<td>• numberOfUsersWithApp: Count of users with this application installed.</td>
</tr>
<tr>
<td></td>
<td>• numberOfDevicesWithApp: Count of devices on which this application is installed.</td>
</tr>
<tr>
<td></td>
<td>• application: Object containing the data set listed above for this application. Use the script to parse additional data from this set that you might need.</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

Conditions

Get Applications conditions

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved the list of applications available on the SCCM host.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve the list of applications available on the SCCM host.</td>
</tr>
</tbody>
</table>

Get Deployments activity

The Get Deployments activity returns the list of deployments performed by Orchestration using a Microsoft System Center Configuration Manager (SCCM) server.

The Get Deployments activity uses the PowerShell activity template to access the deployments on the SCCM server. The activity is configured to use a MID Server with PowerShell capabilities and to run a MID Server script called `GetDeployments.ps1` that returns the deployments on the host. This script filters the results of the GET, so that only specific attributes are returned for the deployments on the SCCM server. Filtering the results in this manner controls the size of the payload, while providing the most desirable deployment data. The list of available deployments is returned as an array in a JSON object.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > System Center Configuration Manager (SCCM).
Note: The Get Deployments activity does not use pre-processing scripts.

Input variables

Get Deployments input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
</tbody>
</table>

Output variables

Get Deployments output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>deployments</td>
<td>The deployments array contains these attributes:</td>
</tr>
<tr>
<td></td>
<td>• id: Primary key of the SCCM application.</td>
</tr>
<tr>
<td></td>
<td>• applicationId: Primary key of the SCCM application.</td>
</tr>
<tr>
<td></td>
<td>• softwareName: Name of the software that will be deployed.</td>
</tr>
<tr>
<td></td>
<td>• collectionId: Primary key of the SCCM collection.</td>
</tr>
<tr>
<td></td>
<td>• collectionName: Name of the SCCM collection.</td>
</tr>
<tr>
<td></td>
<td>• desiredConfigType: Possible values are: Install (1) and Uninstall (2).</td>
</tr>
<tr>
<td></td>
<td>• deploymentIntent: Intended purpose of the deployment. Possible values are: Available (1) and Required (2).</td>
</tr>
<tr>
<td></td>
<td>• numberSuccess: Number of clients that successfully installed the deployment.</td>
</tr>
<tr>
<td></td>
<td>• numberErrors: Number of clients with an error when installing the deployment.</td>
</tr>
<tr>
<td></td>
<td>• deployment: Object containing the data set of attributes listed here for this deployment. Use the post-processing script to parse additional data from this set that you might need.</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>
Conditions

Get Deployments conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved the list of deployments performed by Orchestration using an SCCM host.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve the list of deployments performed by Orchestration using an SCCM host.</td>
</tr>
</tbody>
</table>

Get Device Collections activity

The Get Device Collections activity returns the list of available device collections on a Microsoft System Center Configuration Manager (SCCM) host.

The Get Device Collections activity uses the Powershell activity template to access the collections on the SCCM server. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called `GetDeviceCollections.ps1` that returns the device collections on the server. This script filters the results of the GET, so that only specific attributes are returned for the device collections on the SCCM server. Filtering the results in this manner controls the size of the payload, while providing the most desirable device collection data. The list of available collections is returned as an array in a JSON object.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > System Center Configuration Manager (SCCM).

Note: The Get Device Collections activity does not use pre-processing scripts.

Input variables

Get Device Collections input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
</tbody>
</table>
Output variables

Get Device Collections output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>deviceCollections</td>
<td>The <code>deviceCollections</code> array contains these attributes:</td>
</tr>
<tr>
<td></td>
<td>• <code>id</code>: Primary key of the SCCM device collection.</td>
</tr>
<tr>
<td></td>
<td>• <code>name</code>: Name of the SCCM device collection.</td>
</tr>
<tr>
<td></td>
<td>• <code>collectionType</code>: Type of SCCM collection. In this case, the value is <code>device</code>.</td>
</tr>
<tr>
<td></td>
<td>• <code>localMemberCount</code>: Count of device collection members visible at the local SCCM site.</td>
</tr>
<tr>
<td></td>
<td>• <code>memberCount</code>: Count of all device collection members.</td>
</tr>
<tr>
<td></td>
<td>• <code>deviceCollection</code>: Object containing the data set of attributes listed here for this device collection. Use the post-processing script to parse additional data from this set to use.</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

Conditions

Get Device Collections conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved a list of device collections available on the SCCM host.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve a list of device collections available on the SCCM host.</td>
</tr>
</tbody>
</table>

Get User Collections activity

The Get User Collections activity returns the list of available user collections on a Microsoft System Center Configuration Manager (SCCM) server.

The Get User Collections activity uses the Powershell activity template to access the user collections on the SCCM server. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called `GetUserCollections.ps1` that returns the user collections on the host. This script filters the results of the GET, so that only specific attributes are returned for the user collections on the SCCM server. Filtering the results in this manner controls the size of the payload, while providing the most desirable user collection data. The list of available collections is returned as an array in a JSON object.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > System Center Configuration Manager (SCCM) .
Note: The Get User Collections activity does not use pre-processing scripts.

Input variables

Get User Collections input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
</tbody>
</table>

Output variables

Get User Collections output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>userCollections</td>
<td>The userCollections array contains these attributes:</td>
</tr>
<tr>
<td></td>
<td>• id: Primary key of the SCCM user collection.</td>
</tr>
<tr>
<td></td>
<td>• name: Name of the SCCM user collection.</td>
</tr>
<tr>
<td></td>
<td>• collectionType: Type of SCCM collection. In this case, the value is user.</td>
</tr>
<tr>
<td></td>
<td>• localMemberCount: Count of user collection members visible at the local SCCM site.</td>
</tr>
<tr>
<td></td>
<td>• memberCount: Count of all user collection members.</td>
</tr>
<tr>
<td></td>
<td>• userCollection: Object containing the data set of attributes listed here for this user collection. Use the post-processing script to parse additional data from this set to use.</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

Conditions

Get User Collections conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully retrieved the list of available user collections on an SCCM host.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to retrieve the list of available user collections on an SCCM host.</td>
</tr>
</tbody>
</table>
Is Device in Collection activity

This activity verifies if a device exists in an SCCM device collection.

The Is Device in Collection activity uses the PowerShell activity template to verify if a specific device exists in an SCCM device collection. The activity is configured to use a MID Server with PowerShell capabilities and to run a MID Server script called IsDeviceInCollection.ps1 to perform the test.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > System Center Configuration Manager (SCCM).

Input variables

Is Device in Collection input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
<tr>
<td>collection</td>
<td>Name of the device collection.</td>
</tr>
<tr>
<td>device</td>
<td>Name of the device to verify is in the collection.</td>
</tr>
</tbody>
</table>

Output variables

Is Device in Collection output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>output</td>
<td>Variable that contains the test result: True/False</td>
</tr>
<tr>
<td>errorMessage</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

Conditions

Is Device in Collection conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exist</td>
<td>The device exists in the collection.</td>
</tr>
<tr>
<td>Not exist</td>
<td>The device does not exist in the collection.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed.</td>
</tr>
</tbody>
</table>

Is User in Collection activity

This activity verifies if a user exists in an SCCM user collection.

The Is User in Collection activity uses the PowerShell activity template to verify if a specific user exists in an SCCM user collection. The activity is configured to use a MID Server with PowerShell capabilities and to run a MID Server script called IsUserInCollection.ps1 to perform the test.
To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > System Center Configuration Manager (SCCM)**.

### Input variables

**Is User in Collection input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
<tr>
<td>collection</td>
<td>Name of the user collection.</td>
</tr>
<tr>
<td>user</td>
<td>Name of the user to verify is in the collection.</td>
</tr>
</tbody>
</table>

### Output variables

**Is User in Collection output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>output</td>
<td>Variable that contains the test result: True/False</td>
</tr>
<tr>
<td>errorMessage</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

### Conditions

**Is User in Collection conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exist</td>
<td>The user exists in the collection.</td>
</tr>
<tr>
<td>Not exist</td>
<td>The user does not exist in the collection.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed.</td>
</tr>
</tbody>
</table>

### Remove from Device Collection activity

The Remove from Device Collection activity removes a device from a Microsoft System Center Configuration Manager (SCCM) device collection.

The Remove from Device Collection activity uses the **Powershell activity template** to remove a device from a device collection on a Microsoft SCCM server. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called **RemoveFromUserCollection.ps1** to edit the collection.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > System Center Configuration Manager (SCCM)**.
### Input variables

**Remove from Device Collection input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
<tr>
<td>collection</td>
<td>Name of the device collection.</td>
</tr>
<tr>
<td>device</td>
<td>Name of the device to add to the collection.</td>
</tr>
</tbody>
</table>

### Output variables

**Remove from Device Collection output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>output</td>
<td>Variable that contains a value that is passed to other activities in the workflow</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

### Conditions

**Remove from Device Collection conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully removed the device from the SCCM device collection.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to remove the device from the SCCM device collection.</td>
</tr>
</tbody>
</table>

### Remove from User Collection activity

The Remove from User Collection activity removes a user from a Microsoft System Center Configuration Manager (SCCM) user collection.

The Remove from User Collection activity uses the **Powershell activity designer template** to access a user collection on a Microsoft SCCM target host. The activity is configured to use a MID Server with Powershell capabilities and to run a MID Server script called **RemoveFromUserCollection.ps1** to edit the collection.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > System Center Configuration Manager (SCCM)**.
Input variables

Remove from User Collection input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sccmServer</td>
<td>The fully qualified domain name (FQDN) of the SCCM server.</td>
</tr>
<tr>
<td>collection</td>
<td>Name of the user collection.</td>
</tr>
<tr>
<td>user</td>
<td>Name of the user to add to the collection.</td>
</tr>
</tbody>
</table>

Output variables

Remove from User Collection output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>output</td>
<td>Variable that contains a value that is passed to other activities in the workflow.</td>
</tr>
<tr>
<td>error</td>
<td>Variable that contains the activity output error message.</td>
</tr>
</tbody>
</table>

Conditions

Remove from User Collection conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully removed the user from the SCCM user collection.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to remove the user from the SCCM user collection.</td>
</tr>
</tbody>
</table>

SFTP File Transfer activity pack

Use the SFTP File Transfer activities to manage files and directories on an SFTP server and to move files from one SFTP server to another.

The SFTP activity pack includes scoped activities for common file transfer tasks and a ready-to-use workflow that includes these activities. Use the SFTP workflow to control which files are going to be moved, what conditions the files need to meet, the order in which the files are moved, and which overwrite options are executed.

**Note:** To use the SFTP File Transfer activities and workflow, you must request activation of the Orchestration - SFTP plugin.
SFTP File Transfer workflow

The SFTP File Transfer activity pack includes a scoped workflow that uses multiple activities to manage files on SFTP servers.

The maximum activity count for the SFTP File Transfer workflow is set to 10,000. This allows the workflow to move up to 1000 files from one server to another.

Accessing the workflow

- Navigate to Workflow > Workflow Editor and select the Workflows tab.
- Click on the SFTP File Transfer workflow to open it.
- Click the information icon in the workflow header to display the properties dialog box.

Input variables

SFTP File Transfer workflow input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source host</td>
<td>Name or IP address of the server containing the files you want to move.</td>
<td></td>
</tr>
<tr>
<td>Source port</td>
<td>Port number to use to communicate with the source server.</td>
<td>22</td>
</tr>
<tr>
<td>Source directory</td>
<td>Full path to the directory where the source files are located.</td>
<td></td>
</tr>
<tr>
<td>Source files</td>
<td>Names of specific source files to move. Separate the file names in this list with semi-colons. This field supports the use of wild cards. For information about how the values in this field are affected by options in other fields, see the section below the table.</td>
<td></td>
</tr>
<tr>
<td>Excluded files</td>
<td>Names of specific source files to exclude from the move. The system moves all other files found in the source directory or subfolders. Separate the file names in this list with semi-colons. This field supports the use of wild cards. For information about how the values in this field are affected by options in other fields, see the section below the table.</td>
<td></td>
</tr>
<tr>
<td>Target host</td>
<td>Name or IP address of the server to which the files are being moved.</td>
<td></td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
<td>Default value</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Target port</td>
<td>Port number to use to communicate with the target host.</td>
<td>22</td>
</tr>
<tr>
<td>Datetime format</td>
<td>Timestamp format to apply when the $[DateTime]$ variable is used in the Target directory or Target files field. The system uses the current time from the instance to create timestamp values.</td>
<td>yyyy-MM-dd</td>
</tr>
<tr>
<td>Target directory</td>
<td>Path to the directory in the target host where the files are being moved. You can specify a target directory whose name includes the timestamp by adding the $[DateTime]$ variable to the directory name. For example, you might enter this path to a target directory: /user/jacinto.gawron/documents/projects_ $[DateTime]$. This produces the projects_20150505 directory. When the timestamp variable is used, the system uses the format specified in the Datetime format field.</td>
<td></td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
<td>Default value</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Target file</td>
<td>Format to use for target file names when a timestamp is added. You can configure the system to add the timestamp as a prefix to the file name or insert the timestamp into the name, using these variables:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• $[DateTime]$: Current timestamp, using the format defined in the Datetime format field.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• $[SourceFile]$: Complete file name.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• $[SourceFile:Base]$: Base file name without the extension.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• $[SourceFile:Ext]$: File extension only.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A target file name with the timestamp added as a prefix is expressed as: $[DateTime]_ $[SourceFile]. This produces a file name that looks like this: 20150505_file1.txt</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A target file name with the timestamp inserted into the name is expressed as: $[SourceFile:Base]_ $[DateTime]$[SourceFile:Ext]. This produces a file name that looks like this: file1_20150505.txt</td>
<td></td>
</tr>
<tr>
<td>Apply move conditions</td>
<td>Check box to apply conditions to the file transfer. If this check box is selected, additional fields appear for setting conditions.</td>
<td>false</td>
</tr>
<tr>
<td>Minimum file size, in bytes</td>
<td>Condition that defines a target file's minimum size requirement. This setting can help determine if the file is valid. This field appears when the Apply move conditions check box is selected.</td>
<td>0</td>
</tr>
<tr>
<td>Maximum file size, in bytes</td>
<td>Condition that defines a target file's maximum size requirement. This field appears when the Apply move conditions check box is selected.</td>
<td>-1</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
<td>Default value</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>File is not older than</td>
<td>Condition that sets the earliest acceptable date for this file's age range. The range starts at 00:00 (midnight) on the date specified. This field appears when the <strong>Apply move conditions</strong> check box is selected.</td>
<td></td>
</tr>
<tr>
<td>File is not newer than</td>
<td>Condition that sets the latest acceptable date for this file's age range. The range ends at 23:59 on the date specified. This field appears when the <strong>Apply move conditions</strong> check box is selected.</td>
<td></td>
</tr>
<tr>
<td>Include subfolders</td>
<td>Check box to move the files from subfolders in the source directory. For information about how your selection affects other fields in the form, see the section below the table.</td>
<td></td>
</tr>
<tr>
<td>Move order</td>
<td>Order in which the files are moved from the source to the target. The possible options are:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong> (same order as files in the source directory)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>By timestamp</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>By file name</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>By file size</strong></td>
<td></td>
</tr>
<tr>
<td>Sort order</td>
<td>Order in which the files are sorted in the target directory, using the option selected in the <strong>Move order</strong> field. Sorting options are <strong>Ascending</strong> and <strong>Descending</strong>.</td>
<td><strong>desc</strong></td>
</tr>
<tr>
<td>Maximum number of retries</td>
<td>Number of attempts the activity can make to connect to the target host or to move a file before timing out. When the retry limit to move a file or to connect to the host is exceeded, the system logs a failure. If the maximum number of failures is not exceeded, the system attempts to connect again or to move the next file named.</td>
<td>2</td>
</tr>
<tr>
<td>Time between retries, in seconds</td>
<td>Time, in seconds, between repeat attempts to connect to the target or to begin moving a file.</td>
<td>10</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
<td>Default value</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Maximum number of failures</td>
<td>Acceptable number of times the system can fail to connect to the target host or to move a file before it quits trying. A failure occurs when the number of configured retries is exceeded. Using the default settings, failure occurs when the system cannot connect to the target or move a file after two retries.</td>
<td>0</td>
</tr>
<tr>
<td>Duplicate file action</td>
<td>Action to take if a file being moved already exists in the target directory. The choices are:</td>
<td>overwrite</td>
</tr>
<tr>
<td></td>
<td>• Overwrite if file exists (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Rename with index</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Do not move</td>
<td></td>
</tr>
<tr>
<td>Preserve file attributes</td>
<td>Check box to use the time stamp and mode information from the source files for the copied files. If this check box is cleared, the copied files have a current time stamp and mode.</td>
<td>false</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This timestamp is a file attribute and is not appended to the file name.</td>
<td></td>
</tr>
<tr>
<td>Upon success, remove files from source</td>
<td>Check box to delete original files from the source directory when they are copied to the new location. Clear this check box to keep the source files in their current location in the source host.</td>
<td>false</td>
</tr>
<tr>
<td>Upon failure, keep moved files on target</td>
<td>Check box to keep any files on the target that were moved successfully, even if the entire file transfer operation ended in failure. If this check box is cleared, the system removes all successfully transferred files from the target when general failure occurs.</td>
<td>true</td>
</tr>
<tr>
<td>Credential tag for source</td>
<td>Specific credential alias this activity must use to run SSH commands on the source host.</td>
<td></td>
</tr>
<tr>
<td>Credential tag for target</td>
<td>Specific credential tag this activity must use to run SSH commands on the target host.</td>
<td></td>
</tr>
</tbody>
</table>
File selection logic

When selecting the files to move from the source host, the system uses this logic:

- If the **Source files** and **Excluded files** fields are empty, the system moves all the files in the source directory.
- When the **Include subfolders** check box is selected, the following dependencies exist:
  - If no files are specified in the **Source files** and **Exclude files** fields, the system moves all files in the source directory and all files in all subfolders of the source directory.
  - If the **Source files** field contains file names, the system moves those files from their location on either the source directory or any of its subfolders.
  - If the **Exclude files** field contains file names, the system moves all the files from the source directory and its subfolders except those excluded files.
- When the **Include subfolders** check box is cleared, the system looks only in the source directory for files to move or exclude.

Copy File activity

The Copy File activity copies a file from an SFTP server (source host) to another SFTP server (target host).

Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sourceHost</td>
<td>Name or IP address of the server containing the files you want to transfer.</td>
</tr>
<tr>
<td>sourcePort</td>
<td>Port number to use to communicate with the source server. The default port number is 22.</td>
</tr>
<tr>
<td>sourceFilePath</td>
<td>Full path to the file to copy from the source host.</td>
</tr>
<tr>
<td>targetHost</td>
<td>Name or IP address of the server to which you want to move the files.</td>
</tr>
<tr>
<td>targetPort</td>
<td>Port number to use to communicate with the target server. The default port number is 22.</td>
</tr>
<tr>
<td>targetFilePath</td>
<td>Full path to the copied file on the target host.</td>
</tr>
<tr>
<td>tempFileSuffix</td>
<td>Temporary suffix to use when moving a file. If this field contains a value, the activity deletes the duplicate target file, if it exists, and then copies the source file to a temporary file using <strong>targetFilePath</strong> + <strong>tempFileSuffix</strong> as the name. Upon completion, the activity renames the file to the actual target file name. If this field is blank, the activity copies the source file directly to the target file and overwrites it, if it already exists.</td>
</tr>
<tr>
<td>sourceCredentialTag</td>
<td>Specific credential alias this activity must use to run SSH commands on the source host.</td>
</tr>
</tbody>
</table>
### Output variables

**Copy File output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessages</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
<tr>
<td>result</td>
<td>Text message advising that the command was executed successfully.</td>
</tr>
</tbody>
</table>

### Conditions

**Copy File conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in copying the file.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to copy the file.</td>
</tr>
</tbody>
</table>

### Create Directory activity

The Create Directory activity creates a new directory on an SFTP server.

### Input variables

**Create Directory input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sourceHost</td>
<td>Name or IP address of the server containing the files you want to move.</td>
</tr>
<tr>
<td>sourcePort</td>
<td>Port number to use to communicate with the source server. The default port number is 22.</td>
</tr>
<tr>
<td>sourceDirectory</td>
<td>Path to the target directory to create.</td>
</tr>
<tr>
<td>sourceCredentialTag</td>
<td>Specific credential alias this activity must use to run SSH commands on the host.</td>
</tr>
</tbody>
</table>
Output variables

Create Directory output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
<tr>
<td>result</td>
<td>Text message advising that the command was executed successfully.</td>
</tr>
</tbody>
</table>

Conditions

Create Directory conditions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in creating the directory.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to create the directory.</td>
</tr>
</tbody>
</table>

Get File List activity

The Get File List activity returns a list of files from a given directory and its subdirectories on an SFTP server (source host).

Input variables

Get File List input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sourceHost</td>
<td>Name or IP address of the server containing the files you want to list.</td>
</tr>
<tr>
<td>sourcePort</td>
<td>Port number to use to communicate with the target server. The default port number is 22.</td>
</tr>
<tr>
<td>sourceDirectory</td>
<td>Path to the target directory containing the files to list.</td>
</tr>
<tr>
<td>sourceFiles</td>
<td>List of target files to return. This is a comma separated list that accepts wildcards, such as *.txt.</td>
</tr>
<tr>
<td>excludedFiles</td>
<td>List of target files to exclude. This is a comma separated list that accepts wildcards, such as *.txt.</td>
</tr>
<tr>
<td>includeSubfolders</td>
<td>True/false variable that determines if files from subfolders are included in the list. The default value for this variable is false.</td>
</tr>
<tr>
<td>sourceCredentialTag</td>
<td>Specific credential alias this activity must use to run SSH commands on the host.</td>
</tr>
</tbody>
</table>
### Output variables

**Get File List output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessage</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources. If this variable is not null, the operation has failed. An activity can examine the error message to customize a condition. For example, if the error message contains <code>NO_SUCH_FILE</code>, the activity can be considered successful, depending on circumstances.</td>
</tr>
<tr>
<td>result</td>
<td>List of requested files, returned as a JSON string.</td>
</tr>
</tbody>
</table>

### Conditions

**Get File List conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in listing the requested files.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to list the requested files.</td>
</tr>
</tbody>
</table>

### Remove File or Directory activity

The Remove File or Directory activity removes a file or a directory on an SFTP server, including subdirectories, when configured.

### Input variables

**Remove File or Directory input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sourceHost</td>
<td>Name or IP address of the server containing the files you want to remove.</td>
</tr>
<tr>
<td>sourcePort</td>
<td>Port number to use to communicate with the target server. The default port number is 22.</td>
</tr>
<tr>
<td>sourceFilePath</td>
<td>Full path to the file or directory to remove. To remove multiple files or directories using a single activity, enter a semicolon-separated list of paths in this field.</td>
</tr>
<tr>
<td>isDirectory</td>
<td>True/false variable that determines if the specified file path is a directory. The default value for this variable is false.</td>
</tr>
</tbody>
</table>
### Variable

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>includeSubfolders</td>
<td>True/false variable that determines if the given directory and all of its subfolders should be removed. The default value for this variable is \textit{false}. If the value for this field is \textit{false}, then the activity can only remove an empty directory. This field appears when the isDirectory checkbox is selected.</td>
</tr>
<tr>
<td>sourceCredentialTag</td>
<td>Specific \textit{credential alias} this activity must use to run SSH commands on the host.</td>
</tr>
</tbody>
</table>

### Output variables

**Remove File or Directory output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessage</td>
<td>The \texttt{executionResult.errorMessages} from the \textit{Activity designer parsing sources}. If this variable is not null, the operation has failed.</td>
</tr>
<tr>
<td>result</td>
<td>Either \textit{success} or \textit{failure}.</td>
</tr>
</tbody>
</table>
| deletionResults      | The \texttt{deletionResults} array contains these attributes:  
  • \texttt{fullPath}: Full path to the file or directory targeted.  
  • \texttt{status}: Either \textit{succeeded} or \textit{failed}.  
  • \texttt{reason}: Text message describing the cause of a failure. |

### Conditions

**Remove File or Directory conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in removing the file or directory specified.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to remove the file or directory specified.</td>
</tr>
</tbody>
</table>

### Rename File or Directory activity

The Rename File or Directory activity renames a file or directory to a new name on an SFTP server.
Input variables

**Rename File or Directory input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sourceHost</td>
<td>Name or IP address of the server containing the file or directory you want to rename.</td>
</tr>
<tr>
<td>sourcePort</td>
<td>Port number to use to communicate with the target server. The default port number is 22.</td>
</tr>
<tr>
<td>sourceFilePath</td>
<td>Full path to the file or directory to rename.</td>
</tr>
<tr>
<td>targetFilePath</td>
<td>Full path to the renamed file or directory.</td>
</tr>
<tr>
<td>sourceCredentialTag</td>
<td>Specific credential alias this activity must use to run SSH commands on the host.</td>
</tr>
</tbody>
</table>

Output variables

**Rename File or Directory output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessages</td>
<td>The <code>executionResult.errorMessages</code> from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
<tr>
<td>result</td>
<td>A message saying that the operation has been successful. For example, you might see: Rename /tmp/sftp_test/subdir1 to /tmp/sftp_test/subdir2 complete.</td>
</tr>
</tbody>
</table>

Conditions

**Rename File or Directory conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in renaming the file or directory.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to rename the file or directory.</td>
</tr>
</tbody>
</table>

Set File Attributes activity

The Set File Attributes activity sets common file attributes, such as timestamps, size, permissions, and UID/GID, for a file or directory on an SFTP server.

A good practice is to use the Get File List activity to return a list of files and their attributes first. Then, when you moved a file from a source host to a target host, use the Set File Attributes activity to set the source file attributes on the target file. This is demonstrated in the SFTP File Transfer workflow.
ServiceNow    DocVersion    Now Platform capabilities

Input variables

Set File Attributes input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sourceHost</td>
<td>Name or IP address of the server containing the file or directory whose attributes you want to change.</td>
</tr>
<tr>
<td>sourcePort</td>
<td>Port number to use to communicate with the target server. The default port number is 22.</td>
</tr>
<tr>
<td>sourceFilePath</td>
<td>Full path to the file or directory whose attributes you want to change.</td>
</tr>
<tr>
<td>userID</td>
<td>User ID attribute to apply to the file or directory. The UID and GUID variables must be set together as a pair.</td>
</tr>
<tr>
<td>groupID</td>
<td>Group ID attribute to apply to the file or directory. The UID and GUID variables must be set together as a pair.</td>
</tr>
<tr>
<td>permissions</td>
<td>File or directory permissions to set for the user and group specified. This value must be expressed as an integer, such as 16877, which defines these permissions: rwxr-xr-x. Note: The permissions number is an internal value returned by the Get File List activity.</td>
</tr>
<tr>
<td>accessTimestamp</td>
<td>Override the timestamp when the file or directory was last accessed. The access and modification timestamps must be set together as a pair.</td>
</tr>
<tr>
<td>modificationTimestamp</td>
<td>Override the timestamp when the file or directory was last modified. The access and modification timestamps must be set together as a pair.</td>
</tr>
<tr>
<td>sizeInBytes</td>
<td>Size of the file or directory, expressed in bytes.</td>
</tr>
<tr>
<td>sourceCredentialTag</td>
<td>Specific credential alias this activity must use to run SSH commands on the host.</td>
</tr>
</tbody>
</table>

Output variables

Set File Attributes output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources. If this variable is not null, the operation has failed.</td>
</tr>
</tbody>
</table>
ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Text message advising that the command was executed successfully.</td>
</tr>
</tbody>
</table>

Conditions

**Set File Attributes conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity succeeded in changing the attributes of the specified file or directory.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to change the attributes of the specified file or directory.</td>
</tr>
</tbody>
</table>

**SSH activity pack**

Orchestration provides an activity pack of SSH activities that were customized using the ServiceNow activity designer.

These activities perform the same functions as SSH activities by the same name from previous releases and replace those activities for all new workflows. The custom SSH activities were built with the Create an SSH activity, which gives workflow administrators the ability to store input and output variables in the databus.

**Note:** Existing workflows from earlier versions that were created with legacy SSH activities continue to function normally after an upgrade to Geneva. However, all new workflows must use these custom SSH activities.

To use the SSH custom activities, you must request activation of the Orchestration - SSH plugin.

**Secure Copy activity**

The Secure Copy activity copies a file from one host to another, without storing the copied file on the MID Server.

This activity replaces an SSH activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the SSH activity designer template, which gives workflow administrators the ability to store input and output variables in the databus.

**Input variables**

<table>
<thead>
<tr>
<th>Input variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>from_host</td>
<td>Host name or IP address of the source machine.</td>
</tr>
<tr>
<td>from_scp_file</td>
<td>Name of the file to copy, including the absolute path.</td>
</tr>
</tbody>
</table>
### Input variable

<table>
<thead>
<tr>
<th>Input variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>to_host</td>
<td>Host name or IP address of the target machine.</td>
</tr>
<tr>
<td>to_scp_file</td>
<td>Path to the target file. This path can be absolute or relative to the logged in user’s home directory.</td>
</tr>
<tr>
<td>debug_mid</td>
<td>Check box that enables debug logging when selected.</td>
</tr>
<tr>
<td>debug_ssh</td>
<td>Check box that enables J2SSH debug logging when selected.</td>
</tr>
</tbody>
</table>

### Output variables

#### Secure Copy output variables

<table>
<thead>
<tr>
<th>Output variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>payload</td>
<td>The <code>executionResult.payload</code> from the Activity designer parsing sources.</td>
</tr>
<tr>
<td>output</td>
<td>The <code>executionResult.output</code> from the parsing sources.</td>
</tr>
</tbody>
</table>

### Conditions

#### Secure Copy conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully copied the file from one host to another.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to copy the file from one host to another.</td>
</tr>
</tbody>
</table>

### Files Compare activity

The Files Compare activity compares two files on a Linux or UNIX computer.

This activity replaces an SSH activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the [SSH activity designer template](https://docs.servicenow.com), which gives workflow administrators the ability to store input and output variables in the databus.

To access this activity in the Workflow Editor, select the **Custom** tab, and then navigate to **Custom Activities > Global > Orchestration - SSH**.
Input variables

Files Compare input variables

<table>
<thead>
<tr>
<th>Input variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Hostname or IP address of the destination server for SSH activity.</td>
</tr>
<tr>
<td>Directory</td>
<td>Name of the working directory.</td>
</tr>
<tr>
<td>OldFile</td>
<td>Name of the first file to compare.</td>
</tr>
<tr>
<td>NewFile</td>
<td>Name of the second file to compare.</td>
</tr>
</tbody>
</table>

Output variables

Files Compare output variables

<table>
<thead>
<tr>
<th>Output variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>contents</td>
<td>File comparison result. This is the difference of the two compared files.</td>
</tr>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>return-code</td>
<td>Either 0, if the two files are the same, or 1, if the two files are different.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

Conditions

Files Compare conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully compared the specified files.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity could not compare the specified files.</td>
</tr>
</tbody>
</table>

File Read activity

The File Read activity reads a file on a Linux or UNIX computer.

This activity replaces an SSH activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the SSH activity designer template, which gives workflow administrators the ability to store input and output variables in the databus.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Global > Orchestration - SSH.
Input variables

File read input variables

<table>
<thead>
<tr>
<th>Input variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Hostname or IP address of the destination server for SSH activity.</td>
</tr>
<tr>
<td>Directory</td>
<td>Name of the working directory.</td>
</tr>
<tr>
<td>File</td>
<td>The name of the file to read.</td>
</tr>
</tbody>
</table>

Output variables

File read output variables

<table>
<thead>
<tr>
<th>Output variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>contents</td>
<td>Content of the file to read.</td>
</tr>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
<tr>
<td>errorMessage</td>
<td>The executionResult.errorMessages from the Activity designer parsing sources.</td>
</tr>
</tbody>
</table>

Conditions

File Read conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully read the contents of the specified file.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity could not read the contents of the specified file.</td>
</tr>
</tbody>
</table>

File Write activity

The File Write activity writes a file on a Linux or UNIX computer.

The source file can be an absolute or relative path from the Directory. If an absolute path is used, then no value is required in the Directory field.

This activity replaces an SSH activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the SSH activity template, which gives workflow administrators the ability to store input and output variables in the databus.
Input variables

File Write input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>Hostname or IP address of destination server for SSH activity.</td>
</tr>
<tr>
<td>directory</td>
<td>Name of the working (target) directory.</td>
</tr>
<tr>
<td>file</td>
<td>Name of the file to be written.</td>
</tr>
<tr>
<td>behavior</td>
<td>Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• overwrite: Creates the file if it does not exist and overwrites the file</td>
</tr>
<tr>
<td></td>
<td>if it does exist.</td>
</tr>
<tr>
<td></td>
<td>• append: Creates the file if it does not exist and appends the new content</td>
</tr>
<tr>
<td></td>
<td>to an existing file.</td>
</tr>
<tr>
<td></td>
<td>• create only: Creates the file if it does not exist and fails if the file</td>
</tr>
<tr>
<td></td>
<td>does exist.</td>
</tr>
<tr>
<td>contents</td>
<td>What to write or append (depending on the behavior) to the file</td>
</tr>
</tbody>
</table>

Output variables

File Write output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>return_code</td>
<td>Indicates whether or not the file write operation was successful.</td>
</tr>
<tr>
<td>error_message</td>
<td>Message that indicates if an error has occurred. Any value other than 0 indicates a failure.</td>
</tr>
</tbody>
</table>

Conditions

File Write conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity wrote a file in the target directory.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity failed to write a file in the target directory.</td>
</tr>
</tbody>
</table>

File Copy activity

The custom File Copy activity copies a file on a Linux or UNIX computer.

This activity replaces an SSH activity by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to
work normally after upgrading to Geneva. However, all new workflows must use the custom version of this activity. This activity was built with the SSH activity designer template, which gives workflow administrators the ability to store input and output variables in the databus.

To access this activity in the Workflow Editor, select the Custom tab, and then navigate to Custom Activities > Global > Orchestration - SSH.

**Input variables**

**File Copy input variables**

<table>
<thead>
<tr>
<th>Input variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>Hostname or IP address of destination server for SSH activity.</td>
</tr>
<tr>
<td>directory</td>
<td>Name of the working directory.</td>
</tr>
<tr>
<td>src_file</td>
<td>Name of the source file.</td>
</tr>
<tr>
<td>dst_file</td>
<td>The name of the destination file.</td>
</tr>
</tbody>
</table>

**Output variables**

**File Copy output variables**

<table>
<thead>
<tr>
<th>Output variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>Either success or failure.</td>
</tr>
</tbody>
</table>

**Conditions**

**File Copy conditions**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully copied the file on the specified host.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to copy the file on the specified host.</td>
</tr>
</tbody>
</table>

**File Replace String activity**

The File Replace String activity finds and replaces a string in a file on a Linux or UNIX computer.

This activity replaces an SSH activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the SSH activity template, which gives workflow administrators the ability to store input and output variables in the databus.
Input variables

File Replace String input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>Hostname or IP address of destination server for SSH activity.</td>
</tr>
<tr>
<td>directory</td>
<td>Name of the working (target) directory.</td>
</tr>
<tr>
<td>file</td>
<td>Name of the file in which the string is to be replaced.</td>
</tr>
<tr>
<td>find_pattern</td>
<td>A regular expression of the text to replace.</td>
</tr>
<tr>
<td>replace_string</td>
<td>The replacement string for the text found by the expression in the find_pattern variable.</td>
</tr>
<tr>
<td>options</td>
<td>Replacement options:&lt;br&gt;• first: Replaces the first occurrence of the pattern.&lt;br&gt;• all: Replaces all occurrences of the pattern.</td>
</tr>
</tbody>
</table>

Output variables

File Replace String output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>return_code</td>
<td>Indicates whether or not the string was replaced successfully in the target file.</td>
</tr>
<tr>
<td>error_message</td>
<td>Message that indicates if an error has occurred. Any value other than 0 indicates a failure.</td>
</tr>
</tbody>
</table>

Conditions

File Replace String conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity has successfully replaced the string in the file.</td>
</tr>
<tr>
<td>Failure</td>
<td>The activity has failed to replaced the string in the file.</td>
</tr>
</tbody>
</table>

Reset Linux User Password activity

The Reset Linux User Password activity resets the password for a given user on a Linux computer.

This activity requires that the user executing the command be able to run the chpasswd command and, if expiring the password immediately, to run chage with sudo privileges.
This activity replaces an SSH activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the SSH activity template, which gives workflow administrators the ability to store input and output variables in the databus.

### Input variables

**Reset Linux User Password input variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hostname</td>
<td>IP address of the target Linux machine.</td>
</tr>
<tr>
<td>user</td>
<td>Name of the user whose password is being reset.</td>
</tr>
<tr>
<td>password</td>
<td>New password set for this user. The password is a workflow variable that is encrypted either as a password2 field or by calling the encryption method of a Packages.com.glide.util.Encrypter object.</td>
</tr>
<tr>
<td>force_change</td>
<td>Indicates if this password is temporary and to force the named user to change the password at login.</td>
</tr>
</tbody>
</table>

### Output variables

**Reset Linux User Password output variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>return_code</td>
<td>Indicates whether or not the user password reset action was successful.</td>
</tr>
<tr>
<td>error_message</td>
<td>Describes any error that occurred during password reset. If no error occurred, this value is null.</td>
</tr>
</tbody>
</table>

### Conditions

**Reset Linux User Password conditions**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity successfully changed specified user's password</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to change specified user's password.</td>
</tr>
</tbody>
</table>

### Global activities

Global activities are Orchestration activities created in the global scope.
Any activities you create in the global scope are listed in the Global category in the Packs and Custom tabs of the Workflow Editor.

Test Server Alive activity

The Test Server Alive activity determines if a target system is alive by its response to a particular protocol.
This activity replaces an activity by the same name available in releases prior to Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, your workflow will continue to work normally after upgrading to Istanbul. However, all new workflows must use the custom version of this activity. This activity was built with the Probe activity template, which gives workflow administrators the ability to store input and output variables in the databus.

### Input variables

#### Test Server Alive input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>port_probes</td>
<td>A comma separated list of protocols to use to check for signs of activity on the target machine (example: wmi, wins, https, ssh, http, https, snmp, dns)</td>
</tr>
<tr>
<td>hostname</td>
<td>Hostname or IP address of the target system to check.</td>
</tr>
</tbody>
</table>

### Output variables

#### Test Server Alive output variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>alive</td>
<td>Code that indicates whether or not the server is alive. If any value but ‘1’ is returned, the server is not alive.</td>
</tr>
</tbody>
</table>

### Conditions

#### Test Server Alive conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Activity determined that the device is running.</td>
</tr>
<tr>
<td>Failure</td>
<td>Activity failed to determine if the target device is running. Failure could be caused by a missing protocol or a device that is not accessible.</td>
</tr>
</tbody>
</table>

### Orchestration activity designer

The Orchestration activity designer enables a user with either the workflow_admin or activity_creator and workflow_creator roles to construct reusable activities that suit an organization’s business needs.

Activities created by the activity designer offer the following advantages over core activities offered in previous releases:

- Reuse custom activities in multiple workflows.
- Upload and download custom activities from the ServiceNow Store.
- Parse data from standard input formats.
• Test input variables against a target host or endpoint and inspect the payload.
• Automatically map values from a test payload to an activity's output variables.
• Share data between activities.
• View previous versions of an activity.

Access to the activity designer requires activation of ServiceNow Orchestration. For instructions about managing transitions and conditions for all activities, see Workflow activities.

Orchestration provides numerous pre-defined activities, which are reusable components that can be used in numerous workflows without having to understand the complexities of the underlying system. These activities are grouped into activity packs, which address specific business needs, such as: Active Directory, Azure AD, Exchange, Infoblox DDI, and PowerShell. There are other ServiceNow applications which provide and maintain their own separate activity packs, such as Security Incident Response, Cloud Management, or Release Automation.

Customers can also build their own activities and activity packs. You can construct custom activities with a specified template through the Orchestration Activity Designer. Custom-built activities built with the Activity Designer are referred to as activity elements. Activity elements provide optimal operations, enable code reuse, and minimize the need to write code. They also enable you to follow the flow of data within a given workflow across orchestration activities. Incorporating activity elements limits the dependency on the scratchpad which reduces problems in complex workflows. Limit the use of core activities, like ‘Run Script’, unless you need direct access the scratchpad, for example, for a counter. Activity elements do not have direct access to the scratchpad. You can, however, pass scratchpad variables as inputs into your activities.

Orchestration activities created by the activity designer:
• Can be uploaded and shared in the ServiceNow App Store
• Use the databus, which allows the activity to have well-defined inputs and outputs
• Share data across activities within a workflow
• Use versioning
• Provide a consistent approach for activity development regardless protocol

Note: Prior to the Fuji release, activities were built with Activity Definitions. In Fuji, a new architecture was introduced using the Activity Designer. Orchestration Core activities, built originally as Activity Definitions, have been converted to use the new template format (Activity Elements) and the databus offered with the activity designer. Workflows in upgraded instances that use legacy activities continue to work normally.

For instructions on using activities to construct a workflow, see Add an activity to a workflow.

Introduction to credentials, connections, and aliases for Orchestration

All application integrations in Orchestration require connection information, credentials, and connection and credential aliases to their respective applications to access resources.

Before you can execute an application integration in Orchestration, you must create and configure the corresponding connection information and credentials. The Connections pertains to an integration with a system, such as an IP address or endpoint with protocols. It contains specific details, such as database particulars, when integrating with a database. The associated Credentials are the authentication data required to make the connection.

Connection information and credentials can vary between QA/Development/Production environments for the same integration. The tight coupling between this data and application metadata, such as workflow or job scheduling, make application metadata obsolete when you change environments. To alleviate this problem, the concept of an alias is introduced, for connections and credentials, to decouple this data from application metadata. These aliases allow customers to design their application metadata to couple to an alias, which during runtime resolves to connection and credential data.
There are two types of aliases, a **connection and credential alias** and a **credential alias**. There are business rules that enforce certain constraints on these aliases. Names should contain alphabets, numbers, and underscores but cannot have special characters. The alias must be unique in a scope. If you choose to have multiple active connections, you can have more than one active connection in the same domain. If you do not choose this option, you can have only one active connection in per domain.

**Note:** If you enable multiple active connections, when the connection records resolve, your application picks one connection based on an established order. The order of the connections depends on the API you use to retrieve connection data.

You can add additional connection attributes to an alias, which are available in connection data during runtime. Variables overridden by connection administration during run time should not affect the alias.

The **credential alias** resolves only credential data. Along with alias data model, you can use a scriptable API which can get connection and credential data during runtime.

**Using Connection and Credential Alias with Orchestration**

Define an alias to label a credential or connection record.

The Credential and Connection Alias defines an alias that labels a credential or connection record. It is extended from the sys_metadata table. It requires the admin role. The credential_admin and connection_admin have read access to sys_alias. A connection alias contains:

- **Name**
  - Name of the alias.

- **ID**
  - This field is based on the format "scope name.alias name" Unique index on ID to ensure unique record based on scope name + name. If the scope is global, the ID is the alias name.

- **Type**
  - You can select either 'Credential' or 'Connection and Credential'. The default is Connection and Credential.

- **Connection type**
  - This field is applicable when the alias type is set to Connection and Credential. There are three connection types: HTTP, JDBC, JMS. The default is HTTP.

If you create a workday alias in global scope, the ID is set to workday

If you create a workday alias in hr app scope, the ID is set to x_hr_app.workday

- Name can only contain alphabets, numbers and underscore.
- During the upgrade, the tag in credential record will be migrated to connection alias. If the tag in previous release's credential record contains special characters other than alphabets, numbers and underscore, the tag data will be preserved during the upgrade. The user still can use these connection alias, but the user cannot update these alias, unless he removes these special characters when do the update.

**Using credentials with Orchestration**

Orchestration requires credentials to access resources.
**Credential table**

The credential table (discovery_credential) defines credentials that can be used for integration. In the previous release, the Credential table contains a string-type tag field, which labels a credential and the tag is used in orchestration activities. In the madrid release, we rename tag to credential alias, and change the type from string to GlideList, which is a reference to connection alias table.

**Credential types**

The following credential types are provided:

<table>
<thead>
<tr>
<th>Credential type</th>
<th>Description</th>
<th>Supports Test Credential option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicative credentials</td>
<td>The credentials to explore the applications on a device or computer. #unique_2308 often need applicative credentials.</td>
<td>No</td>
</tr>
<tr>
<td>Amazon Web Service credentials</td>
<td>The Amazon Web Services (AWS) master account, access key ID, and secret access key.</td>
<td>No</td>
</tr>
<tr>
<td><strong>Note:</strong> You cannot test AWS credentials through the Test</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Azure Service Principal and Enterprise Agreement credentials</td>
<td>The Azure service principals required for an Azure subscription.</td>
<td>No</td>
</tr>
<tr>
<td>Basic authentication credentials</td>
<td>A user name and password.</td>
<td>No</td>
</tr>
<tr>
<td>CIM credentials</td>
<td>The user name and password required to access a CIMOM - Common Information Model Object Manager (CIM) server, which obtains information about VMware ESX servers.</td>
<td>No</td>
</tr>
<tr>
<td>Cloud credentials</td>
<td>Credentials that Orchestration uses to access cloud resources.</td>
<td>No</td>
</tr>
<tr>
<td>JDBC credentials</td>
<td>A user name and password to access a Java Database Connectivity (JDBC) connection.</td>
<td>Yes</td>
</tr>
<tr>
<td>JMS credentials</td>
<td>A user name and password to access a Java Message Service (JMS).</td>
<td>Yes</td>
</tr>
<tr>
<td>OAuth 2.0 credentials</td>
<td>OAuth 2.0 credentials enable ServiceNow to obtain access to user accounts on an HTTP service.</td>
<td></td>
</tr>
<tr>
<td>SNMP community credentials</td>
<td>The community string to access devices via SNMP.</td>
<td>Yes</td>
</tr>
<tr>
<td>SNMPv3 credentials</td>
<td>The user name and keys required to access devices on your SNMP v3 network.</td>
<td>Yes</td>
</tr>
<tr>
<td>SSH credentials</td>
<td>The user name and password to access Linux and Unix devices.</td>
<td>Yes</td>
</tr>
<tr>
<td>Credential type</td>
<td>Description</td>
<td>Supports Test Credential option</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>SSH private key credentials</td>
<td>The private key credentials to access Linux and Unix devices.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Note: For better security, SSH private key credentials are recommended over SSH password credentials.</td>
<td></td>
</tr>
<tr>
<td>VMware credentials</td>
<td>Credentials to access vCenter resources. These credentials are required for any work that is performed on vCenter, such as cloning a virtual machine.</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows credentials</td>
<td>The user name and password required to access Windows computers. Several permission requirements must be met to use Windows credentials.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**How MID Servers use credentials**

By default, Windows MID Servers use the login credentials of the MID Server service on the host machine to discover Windows devices in the network. You should configure these service credentials so that they have domain or local administrator privileges. For Linux and UNIX machines and network devices, the MID Server uses the SSH and SNMP credentials configured in the instance in Discovery > Credentials.

MID Servers that Orchestration uses must have access to the necessary credentials to execute commands on computers in the network as specified by the Workflow activities. Orchestration can use the same SSH and SNMP credentials as Discovery, but has two additional credentials designed for specific Workflow activities: Windows (for PowerShell) and VMware.

**Encryption and decryption**

The platform stores credentials in an encrypted field on the Credentials [discovery_credentials] table. Once they are entered, they cannot be viewed.

When credentials are requested by the MID Server, the platform decrypts the credentials using the following process:

1. The credentials are decrypted on the instance with the password2 fixed key.
2. The credentials are re-encrypted on the instance with the MID Server's public key.
3. The credentials are encrypted on the load balancer with SSL.
4. The credentials are decrypted on the MID Server with SSL.
5. The credentials are decrypted on the MID Server with the MID Server's private key.

**Note:** The platform does not have separate encryption keys for multi-tenant instances.

**Credential order**

Credentials can be assigned an order value in the Credentials form, which forces the application to try all the credentials at their disposal in a certain sequence. If you do not specify an order value, the application
tries the credentials in the Credentials [discovery_credential] table randomly, until it finds one that works, such as when Orchestration attempts to run a command on an SSH server (such as a Linux or UNIX machine), or when Discovery attempts to query an SNMP device (such as a printer, router, or UPS).

After identifying the credentials for a device, Discovery and Orchestration create an affinity between the credentials and the device using the Credential Affinity [dscy_credentials_affinity] table. All subsequent discoveries or Orchestration activities attempt to match the credentials in this table with a device for which an affinity exists. If credentials for a device change, Discovery and Orchestration try all available credentials again until they create a new affinity.

Note: If Orchestration and Discovery are installed, and credential alias is enabled, multiple affinities can exist. In this case, the platform looks up credentials for each affinity and inserts the credential for the affinity with the lowest order into the probe.

Ordering credentials is useful in the following situations:

- The credentials table contains many credentials, with some used more frequently than others. For example, if the table contains 150 SSH credentials, and 5 of those are used to log into 90% of the devices, it is good practice to configure those five with low order numbers, which places them at the top of the execution list. Discovery and Orchestration will work faster if they try these common credentials first. After the first successful connection, the system knows which credentials to use the next time for each device.
- The system has aggressive login security. For example, if the Solaris database servers in the network only allow three failed login attempts before they lock out the MID Server, configure the database credentials with a low order value.

Credential alias

Credential alias allows flow and workflow creators to:

- Assign individual credentials to any activity in an Orchestration workflow
- Assign individual credentials to any action in Flow Designer
- Assign different credentials to each occurrence of the same activity type in an Orchestration workflow.
- Assign different credentials to each occurrence of the same action in designer flow.

Credential alias also works with credential affinities.

External credential stores

If you do not want credentials stored in your instance, you can use external credential repositories. External credential stores save the credentials in an external site that your instance can access. Only CyberArk is supported.

Connections with Orchestration

Use the connections table to setup a JMS, JDBC, or HTTP(s) connection to a target host.

Connection Table

The Connection table (sys_connection) is the base table for all connection tables. You can setup connections for the following protocols:

- JDBC
- JMS
The connection table references the connection alias table, which couples the connection alias to connection information. Every connection records the following information:

Base connection properties

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the connection. This field must be unique on the table.</td>
</tr>
<tr>
<td>Credential</td>
<td>Specify the credential to use with this connection. This is optional.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>The connection alias resolves your connection and credentials at run time. Only one connection is active per Connection alias at any one time.</td>
</tr>
<tr>
<td>Active</td>
<td>Check to make the current connection active.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain to which the connection belongs.</td>
</tr>
</tbody>
</table>

Credential is unique across active connections, if not empty

Upgrading connection information

The JDBC connection (jdbc_connection) and JMS connection (orch_jms_ds) tables are existing Orchestration connection tables. In madrid, we re-parent them to extend from Connection (sys_connection) table. They move from Orchestration run time plugins to Credentials & Connections plugins. They are originally extended from sys_metadata. The sys_metadata related data will be removed. JDBC field name changes:

- JDBC server is renamed to host
- Database port is renamed to port

Create custom activities using custom activity designer templates

You can create and update different types of custom activities in the Workflow Editor using a custom template.

Roles required: workflow_admin or activity_creator

The Activity Designer contains common steps which are applicable to all the activities that you create. This procedure guides you through the common steps and the order they should be set up. You specify an activity template before you create a custom activity.

1. Navigate to Orchestration > Workflow Editor.
   The Welcome tab of the Workflow Editor opens.
2. On the Custom tab in the palette, click + to create a new activity select the appropriate template from the list.

The Activity Designer form appears, with a stage indicator at the top. All new activities start at the General stage. The current stage shows with a blue underscore.

3. Add the general properties.
   This information is standard for each custom activity, include a name, description, and other related information.

4. Create the template Create input variables for the template.
   Create the variables to pass into the activity in the Inputs form of the activity designer.
5. Optional: Add a pre-processing script.
For input validation or transforming input data, you might need a pre-processing script.

**Note:** This step is not included in the Run Script activity.

6. Click **Continue** to open the Execution Command form, then fill out the **Execution Command** step based on the corresponding execution templates:

- Create a SOAP web service activity
- Create a JDBC activity
- Create a JavaScript Probe activity
- Create a PowerShell activity
- Create a REST web service activity
- Create a Probe activity
- Create an SFTP activity
- Create a Run Script activity
- Create an SSH activity
- Create a JMS activity

7. Optional: Test your inputs.

8. Optional: In the Outputs form, define local and/or output variables.

Local variables can be used for temporary storage when cascading parsing rules. For example, you might extract an XML payload from within a JSON payload. A local variable can access the XML document and use that as a source for another parsing rule. The graphic shows a Local1 variable source to parse data for Output2.

![Local variable graphic](image)

**Define local variable**

9. Use one of the options to assign values to Outputs:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parsing rule</td>
<td>You can create a parsing rule and map them to the output fields by dragging and dropping the variables into the parsing rules structure. The REST, SOAP, and JDBC templates provide auto-mapping to create the parsing rules automatically. If available from the test inputs form, auto-mapping should be used when possible.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Post-processing</td>
<td>Post-processing scripts allow you to code your own output data validation, output parsing code, and related tasks. Post-processing executes after the execution command results have been returned and before the parsing rules and conditions are run. Click Go to Post-Processing (Advanced) to create a post-processing script.</td>
</tr>
</tbody>
</table>

**Note:** If you create a script, this step reflects as a stage in the indicator.

10. Click **Continue** to open the **Conditions** form to create exit condition rules for your activity and then click **Save**.

**General properties for activity designer templates**

The following General Property fields are common to all activity designer templates.

**General Property fields common to all activity designer templates**

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the activity. Select a unique name that makes the activity easily identifiable in the palette. If you do not name the activity, it is identified in the Data tab of the Workflow Editor with an index number when it is added to a workflow. This index reflects the order in which the custom activity was added to the workflow. Only custom activities and their output variables appear in the Data tab.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of what the activity does.</td>
</tr>
<tr>
<td>Image</td>
<td>Icon that identifies an activity of this type in the workflow palette.</td>
</tr>
<tr>
<td>Execution template</td>
<td>Predefined template selected for this activity.</td>
</tr>
<tr>
<td>Application</td>
<td>Current scope set on the instance. To view the scope, click the gear icon on the right side of the title bar in any record or list and look at the value in the Application field. The activity runs in this scope within a workflow. You cannot view or change the scope for the instance in the Workflow Editor.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>Accessibility setting for this activity, by scope. The following options are available:</td>
</tr>
<tr>
<td></td>
<td>• All application scopes: This activity is available to all application scopes.</td>
</tr>
<tr>
<td></td>
<td>• This application scope only: Use of this activity is restricted to the scope named in the Application field.</td>
</tr>
<tr>
<td>Category</td>
<td>Category for this activity in the Custom and Packs tabs. All categories are listed under their scope in the collapsible hierarchy.</td>
</tr>
</tbody>
</table>
Create input variables

Create the variables to pass into the activity in the Inputs form of the activity designer.

You must name your activity in the General form before you can advance to the Inputs stage.

Roles required: workflow_admin or activity_creator

Note: Variable strings in the Inputs form have a 255 character limit.

1. Click the + icon to create a new input variable.
   The designer creates a default variable called Input1.

2. Type your new variable name in the field.
3. To change the name of a variable or any of its attributes, double-click the value and then select or enter a new value in the field that appears.
4. Configure your variable using these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Data type for this variable. Double-click on the field to display the choice list. In addition to the usual data types, you can create input arrays and encrypt individual variables that contain sensitive data. Encrypted variables are passed to the ECC Queue and then decrypted by the MID Server when they run on the target host. Sensitive data returned from running these variables on the host can then be passed to another activity through encrypted output variables.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Marks an input variable as mandatory. Variables marked as mandatory are required fields in the properties form for the activity in the workflow. The input testing feature allows you to filter on mandatory variables.</td>
</tr>
<tr>
<td>Default</td>
<td>Default value for this input variable. Default values are prepopulated for variables in the properties form for the activity in the workflow. You can override this value when you test the variables.</td>
</tr>
</tbody>
</table>

5. To reorder the variable list, select a row and then drag the row to its new location.

When you select a row to move it, the pointer icon changes to an up/down arrow icon (знак наведення).

6. To delete a variable, click the delete icon (знак видалення) in the row.

7. Click **Continue** to advance to the **Execution Command** stage or click **Go to Pre-Processing (Advanced)** to create a script that runs before the activity executes.

*Map an input variable*

After you create the input variables, map them to the fields in the Execution Command form.

Role required: activity_admin, activity_creator
These fields contain values required by the target host or endpoint to authenticate and query for data. Included in this example are fields for a command to run on the target and the MID Server to use, if one is required.

To map a variable, drag it into the appropriate field.

The designer automatically expresses the variable in the syntax the system requires.

Configure the PowerShell execution command
Use the input variables you created to configure the command that Orchestration executes on the Windows target machine.

Create the input variables you need in the Inputs form before you can advance to the Execution Command stage.

Role required: activity_creator, admin
**Note:** You can test the PowerShell connection between the MID Server and the target computer without having to run the activity in a workflow context. For details, see test template outputs.

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.

---

**PowerShell execution command**

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
2. Complete the fields shown in the table.

**Powershell command fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input variable builder. Create variables to map to available fields.</td>
</tr>
<tr>
<td>Target host</td>
<td>Host name or IP address of the target server for this PowerShell activity.</td>
</tr>
<tr>
<td>Script type</td>
<td>Type of script to run on the PowerShell host. Available options are:</td>
</tr>
<tr>
<td></td>
<td>• Custom Powershell command</td>
</tr>
<tr>
<td></td>
<td>• MID Server script file</td>
</tr>
<tr>
<td>MID Server script file</td>
<td>MID Server script file to run. This field is available when the <strong>Script type</strong> selected is <strong>MID Server script file</strong>.</td>
</tr>
<tr>
<td>Command</td>
<td>Command that this activity runs on the target host. This field is available when the <strong>Script type</strong> selected is <strong>Custom Powershell command</strong>.</td>
</tr>
<tr>
<td></td>
<td>You can drag and drop input variables from the variable builder into this field to create your command.</td>
</tr>
<tr>
<td>Powershell variables</td>
<td>Name-value pairs to pass to the host with Powershell. You can create these variables manually, or drag input variables into the Value field. Encrypted input variables retain their encryption, regardless of the data type settings in this field. If you type in a value and select the Encrypted data type, your value appears in plain text in this field and is only encrypted when it passes to the ECC Queue.</td>
</tr>
<tr>
<td>Use MID service account</td>
<td>Forces this activity to authenticate on the target host using the credentials of the MID Server service account only, without trying any other credentials. When this check box is selected, the Credential tag field is not available.</td>
</tr>
<tr>
<td>Credential tag</td>
<td>Specific credential alias this activity must use to run Powershell commands on the host. If this field is left blank, the MID Server tries all the available credentials until it finds a valid one, ending with the MID Server service account. If a credential alias is defined, the MID Server tries the credentials for that alias only and does not try the MID Server service account. This field is not available when the Use MID service account check box is selected.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server to use for querying Powershell, by capabilities. By default, the system selects a Powershell MID Server.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

4. Click **Continue** to advance to the Outputs stage.
Test activity template inputs
You can test the input parameters of a custom activity during its development without having to run the activity in a workflow context.

Create input variables and map them to fields in the Execution Command form or provide actual values for these fields.

Role required: web_service_admin, activity_admin, activity_creator

An input test executes only the input parameters against an endpoint and not the pre-processing or post-processing scripts. You need to use a workflow to test a pre-processing or post-processing script. You do not need to check out the activity to test it, and you can test input variables from any stage in the activity designer, if your activity is properly configured. Typically, the Execution Command stage is the point at which your inputs are ready for testing.

Note: If you intend to use auto-mapping, you must test your input variables.

1. Click Test Inputs.

   The list of input source variables appears. If you added default values for these variables, those values appear in the Substitute Value column. Mandatory variables are marked with a red star. In this example, a SOAP endpoint returns a value for a stock quote variable.

2. Filter the variable list with these controls:
   - **All Inputs**: Displays all input variables. This is the default view.
   - **Mandatory Inputs**: Displays only mandatory input variables.
   - **Inputs Without Defaults**: Shows input variables that do not have assigned default values.

3. Reset values as needed.
   - **Reset default values**: Replaces any test values set in this form with the default values, if they are present.
   - **Clear values**: Clears all values in the input variable list, even if default values exist.
4. When your test values are configured correctly, click **OK**.

The system runs the values for all the inputs configured against the specified target and returns the resulting payload. The buttons in the Response form display different views of the payload. The entire payload appears in the **Raw Output** window.

```
{
  "status_code": 200,
  "body": "<?xml version="1.0" encoding="utf-8"?>
  <soap:Body><GetQuoteResponse xmlns="http://ws.webservice.NET/"><<GetQuoteResult-&lt;StockQuotes&lt;&lt;Stock&gt;&lt;Symbol&gt;NFLG&lt;/Symbol&gt;&lt;Last&gt;78.92&lt;/Last&gt;&lt;Date&gt;7/16/2013&lt;/Date&gt;&lt;Time&gt;4:05PM&lt;/Time&gt;&lt;Change&gt;1.34&lt;/Change&gt;&lt;Open&gt;78.15&lt;/Open&gt;&lt;High&gt;79.15&lt;/High&gt;&lt;Low&gt;77.83&lt;/Low&gt;&lt;Volumn&gt;665,406&lt;/Volumn&gt;&lt;HighLowVolumn&gt;121,486&lt;/HighLowVolumn&gt;&lt;PreviousClose&gt;77.56&lt;/PreviousClose&gt;&lt;PercentageChange&gt;1.73&lt;/PercentageChange&gt;&lt;AnnRange&gt;54.85 &amp;gt; 83.52&lt;/AnnRange&gt;&lt;&lt;Earns&gt;&lt;Earnings&gt;1.31&lt;/Earnings&gt;&lt;P-E&lt;N/A&lt;&lt;/P-E&gt;&lt;&lt;Name&gt;ServiceNow&lt;/Name&gt;&lt;&lt;/Stock&gt;&lt;GetQuoteResponse&gt;/GetQuoteResponse&lt;/soap:Body&gt;</soap:Envelope>

"error": null,
  "header": {
    "X-AspNet-Version": "4.0.30319",
    "Date": "Thu, 16 Jul 2015 23:25:01 GMT",
    "Content-Length": "979",
    "Content-Type": "text/xml; charset=utf-8",
    "Server": "Microsoft-IIS/7.0",
    "X-Powered-By": "ASP.NET",
    "Cache-Control": "private, max-age=0"
  }
}
```

**Response payload from inputs test**

5. To map appropriate parameter values in the payload to variables in the **Outputs** stage automatically, select the **auto-mapping option.**
6. Alternately, you can click **Save for parsing rules** to copy the entire payload to the parsing rules. This allows you to manually select values for the output variables directly from the payload. This action completely overwrites any previous payload that existed in the parsing rules.

7. Click the X in the upper right corner of the window to close it.

**Data encryption for activity variables**

You can protect sensitive data passed from Orchestration activities by encrypting input and output variables.

The system never stores encrypted variables as clear text. If the MID Server is used to fulfill the activity, the corresponding ECC Queue’s input payload is encrypted if an encrypted output variable is defined in the template. Output variables passed to a downstream activity as input variables maintain their encryption throughout processing.

Inputs that require data encryption come from one of these sources:

- **Workflows**: These inputs are provided through the Workflow Editor and must be in the password2 format for two-way encryption.
- **Service catalog requests**: These input values are provided to an activity as encrypted variables from a service catalog item.
- **GlideRecord**: These are variables attached to any ServiceNow table. The source column in the table must be a password2 type variable.
- **Activity outputs**: These are variables passed as outputs from one activity to a downstream activity as inputs, through the data bus.
- **Empty string**: The system allows you to define encrypted input variables but never pass a value into the variable.

**Activity designer template pre-processing fields**

Use the **Pre Processing** form of the activity designer to define a script to run before the activity executes.

**Pre-processing fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input process script</td>
<td>Script to run before the activity executes.</td>
</tr>
<tr>
<td>Variables</td>
<td>Input variables that are available to use as building blocks in the input process script. Click the arrow above the field to open the variables list. Click an item in the tree to add it to your script in the appropriate syntax. The list displays execution parameters and input variables you passed into the activity on the Inputs form. All activity variables added in the Inputs form are read-only and are expressed in the pre-processing script with this syntax: <code>activityInput.variable</code>. Before the activity executes and makes a call to the service or host, you can override the effective execution value of this variable by assigning values to the <code>executionParam.variable_name</code> execution parameter. Refer to the specific execution parameters for your template.</td>
</tr>
</tbody>
</table>
Logging

Activity designers can add logging to the pre-processing using the **ActivityLogger** API, which works for scoped or global applications. Logged data from the script appears in the **Workflow Log** related list in the context records for any workflow that uses the activity. The **Source** for these messages in the workflow log is **ACTIVITY**.

```
Important: To display the debug messages in the workflow log, set the glide.workflow.log.debug property to true.
```

The supported messages are:

- `ActivityLogger.debug("Pre Processing Log Message");`
- `ActivityLogger.info("Pre Processing Log Message");`
- `ActivityLogger.warn("Pre Processing Log Message");`
- `ActivityLogger.error("Pre Processing Log Message");`

**ActivityLogger API**

**Template post-processing fields**

From the **Post Processing** form in the activity designer you can define a script to run after the activity executes.

**Post-processing fields**

To use the results returned by the activity, append the `executionResult` prefix to these parameters.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output process script</td>
<td>Script to run after the activity executes.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variables</td>
<td>Input variables that are available to use as building blocks in the output process script. Click the arrow above the field to open the variables list. Click an item in the tree to add it to your script in the appropriate syntax. The list displays execution results and the variables you passed into the activity on the Inputs form. All activity variables added in the Inputs form are read-only and are expressed in the post-processing script with this syntax: activityInput.variable. For parameter descriptions, refer to the table in the post-processing parameters topic for this activity.</td>
</tr>
</tbody>
</table>

### Logging

Activity designers can add logging to the post-processing script using the `ActivityLogger` API, which works for scoped or global applications. Logged data from the script appears in the Workflow Log related list in the context records for any workflow that uses the activity. The Source for these messages in the workflow log is **ACTIVITY**.

**Important:** To display the debug messages in the workflow log, set the `glide.workflow.log.debug` property to `true`.

The supported messages are:

- `ActivityLogger.debug("Post Processing Log Message");`
- `ActivityLogger.info("Post Processing Log Message");`
- `ActivityLogger.warn("Post Processing Log Message");`
- `ActivityLogger.error("Post Processing Log Message");`
ActivityLogger API

Auto-map activity output variables

You can map parameter values in a test payload to variables in the Outputs tab automatically.

Role required: admin

1. From the Execution Command in the template, select the Inputs tab.
2. Click Test Inputs to test the input parameters.
   If you added actual values for the parameters and fields, the system runs those values against the specified target and returns the resulting payload. If you mapped input variables to fields and parameters, the system displays a dialog box for assigning test values to those variables.
3. Provide test values, if requested, and click OK to display the payload.

The entire payload appears in the Raw Output tab of the Response form.
4. Select an auto-mapping option:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Auto-Map to Local   | Translates the entire payload into a JSON object and places it in the data bus. This allows for post-processing manipulation in JavaScript. This selection causes the entire data field on the right to disappear and the inputs structure to be auto-populated with these default variables:
|                     | • output  |
|                     | • totalRows  |
|                     | • errorMessage  |
|                     | • eccSysId  |
| Auto-Map to Output  | Automatically populates the output variables in the activity with the same default variables used as inputs for the local variable. |

**Note:** No parsing rules are available with auto-mapping selections.

Create an output variable

The Outputs form in the designer contains a variable builder for creating data structures of objects and arrays.

Roles required: activity_admin, activity_creator

Elements in this structure are mapped with Create a parsing rule to specific data contained in payloads returned from an endpoint or host. These variables and their values are then made available locally or for reuse in other activities.

1. Click the + icon in the Outputs column to create a local or output variable.

   Local variables are only available within an activity and are not visible in the data structures displayed in the Custom tab. Output variables are available for reuse in other activities, either individually or as an entire data structure. When you create a new variable of either type, the designer provides a default name of Local1 or Output1.

2. Type your new variable name in the field and select a data type.

   Variable names must be unique within an array or an object. You can assign a data type of Encrypted to output variables that contain sensitive data. Data protected by encryption is passed to other activities or processes encrypted and is never displayed in plain text.

3. To change the name of a variable or any of its attributes, double-click the value, type a new value in the editing field, and then press Enter.

   The icon to the left of the name reflects the data type of the variable.

4. To reorder the variable list, select a row and then drag the row to its new location.

   When you select a row to move it, the pointer icon changes to an up/down arrow icon (▲▼).

5. Drag and drop the row into another location.
6. To reuse a variable from another activity, drag it from the Custom tab in the palette and drop it onto the Local or Output heading at the top of the variable list. To copy an entire data structure, drag the parent object or array into the variable list header. The designer duplicates the copied data structure in the outputs variable builder.

7. To delete a variable, click the delete icon (❌) in the row.

Activity designer template outputs
Output variables contain messages returned from a destination that are available to other activities in a workflow or internally to the activity.
Activity designer output fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable name</td>
<td>Name of a variable, either <strong>Local</strong> or <strong>Output</strong>, that this activity passes.</td>
</tr>
<tr>
<td>Local</td>
<td>Variable that contains a value used within an activity. For example, use a local variable to identify metadata that is processed within an activity before the final value is exported to an output variable.</td>
</tr>
<tr>
<td>Output</td>
<td>Variable that contains a value that is passed to other activities in the workflow.</td>
</tr>
</tbody>
</table>

**Map an output field**

Mapping is configured with parsing rules that allow you to build expressions in the appropriate data format for the selected payload.

Role required: activity_admin, activity_creator
When you are finished creating the output data structure, map each variable to the specific data you want to extract from the target host.

To map a variable, drag it from the **Outputs** variable builder and drop it into an empty **Variable name** field in the Parsing rules section.

See create a parsing rule for instructions on configuring parsing for output variables.

**Create a parsing rule**

Populate output variables defined in a custom activity with payload data returned from an inputs test on an external host or endpoint.

Roles required: activity_admin, activity_creator

1. Navigate to **Workflow > Workflow Editor**.
2. From the **Custom** tab in the palette, open a custom activity.
3. In the Activity Designer form, advance to the **Output** stage.
4. Drag an output variable from the data structure builder into the **Variable name** field in the **Parsing rules** builder.

**Mapping variables to parsing rules**

The parsing rules form appears for the selected variable. By default, the parsing type is set to **Direct**, which populates the variable with all the data from the selected payload, without parsing the contents. Each template has a specific default **parsing source**.
5. Complete the form using the fields in the table. In this example, the parsing type selected is **XML**, which allows you to select specific parameters from the payload to parse.

**Parsing rule for localBody**

<table>
<thead>
<tr>
<th>Parsing source</th>
<th>Variable Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>executionResult.body</td>
<td>activityLocal.localBody</td>
</tr>
</tbody>
</table>

**Expression**

$age

**Sample payload data**

```
<xml version="1.0"/>
<data>
  <user>
    <name=user one</name>
    <age=42</age>
  </user>
  <user>
    <name=user two</name>
    <age=27</age>
  </user>
  <user>
    <name=user three</name>
  </user>
</data>
```

**Parsing result**

27
### Parsing rules fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parsing source</td>
<td>Source of the data returned from the target host or endpoint. Each template opens to a specific, default payload. Available choices depend on the execution template selected for the activity. You can also use local variables as a parsing source if a parsing rule has previously been defined for them. For a list of the available payloads for each template, see Activity designer parsing sources.</td>
</tr>
</tbody>
</table>
| Expression          | Expression used to extract specific data from the selected parsing source. This expression is created from clickable data in the sample payload and appears in the format selected in the Parsing type field. When testing, the expression can return multiple results. Discern which choice gives reliable or predictable results before choosing your expression.  

**Note:** The system cannot generate clickable RegEx expressions from sample data. You must write all regular expressions manually.                                                                                               |
| Variable name       | Revised variable name as it is used in the final output expression. The system adds the activityOutput or activityLocal prefix to the variable you specify.                                                                                                                                                                                                                                             |
| Parsing type        | The language to use for querying the target host's payload. The selections are:  
- Direct: Maps to the entire content of the payload selected in the Parsing source field, without any parsing. This is the default parsing type.                                                                                            
- XML: XPath query used for selecting nodes from an XML payload.                                                                                                                                                                                                                                                                                                                                                           |
|                      | JSON: JSONPath query for selecting parts of a JSON payload.                                                                                                                                                                                                                                                                                                                                                                                                                                |
|                      | RegEx: Parsing method that uses a regular expression to extract data from a payload. The RegEx parsing type does not support multi-line parsing and is not case sensitive.                                                                                                                                                                                                                                                                                        |
| Short description   | Brief description of this parsing rule.                                                                                                                                                                                                                                                                                                                                                                                                                                                         |
| Sample payload data | Sample data from the source containing the data requested. This field is not available for Direct parsing types. After you click Parse sample data, the data in this field cannot be edited, but becomes clickable for the purpose of creating expressions. Click Edit sample data to make the field editable again.   |
6. To retest the inputs, click **Get sample payload from test**. This action reopens the test form, allowing you to substitute different test values and create a different payload.

7. Click **Save** to have the parsing rules overwrite the previous payload with the one you just created.

8. To create an expression for the parsing rule, click the specific parameter you want to see in the sample payload.

   The value for that parameter appears in the **Parsing result** field, and the system creates the appropriate expression in the **Expression** field.

9. Click **Submit** to save the parsing rule for that variable.

**Activity designer parsing sources**

This table lists the parsing sources available with each execution template.

<table>
<thead>
<tr>
<th>Parsing sources</th>
</tr>
</thead>
</table>

### Parsing sources

<table>
<thead>
<tr>
<th>Template</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOAP Web Service</td>
<td>• executionResult.body (Default)</td>
</tr>
<tr>
<td></td>
<td>• executionResult.status_code</td>
</tr>
<tr>
<td></td>
<td>• executionResult.header</td>
</tr>
<tr>
<td></td>
<td>• executionResult.error</td>
</tr>
<tr>
<td>JDBC</td>
<td>• executionResult.output (Default)</td>
</tr>
<tr>
<td></td>
<td>• executionResult.errorMessages</td>
</tr>
<tr>
<td></td>
<td>• executionResult.probeCompletedEccId</td>
</tr>
<tr>
<td></td>
<td>• executionResult.totalRows</td>
</tr>
<tr>
<td>JavaScript Probe</td>
<td>• executionResult.payload (Default)</td>
</tr>
<tr>
<td></td>
<td>• executionResult.output</td>
</tr>
<tr>
<td></td>
<td>• executionResult.eccSysId</td>
</tr>
<tr>
<td></td>
<td>• executionResult.errorMessages</td>
</tr>
<tr>
<td>Powershell</td>
<td>• executionResult.output (Default)</td>
</tr>
<tr>
<td></td>
<td>• executionResult.tags</td>
</tr>
<tr>
<td></td>
<td>• executionResult.error</td>
</tr>
<tr>
<td>REST Web Service</td>
<td>• executionResult.body (Default)</td>
</tr>
<tr>
<td></td>
<td>• executionResult.status_code</td>
</tr>
<tr>
<td></td>
<td>• executionResult.header</td>
</tr>
<tr>
<td></td>
<td>• executionResult.error</td>
</tr>
</tbody>
</table>
Activity designer parsing rule example

In this example, the parsing rule is configured to populate the activityOutput.ipv4 variable with the value for the IP address from a domain server, using PowerShell.

Role required: activity_creator, activity_admin

To generate the sample data, the administrator must actually run the command on the host and then paste the data returned into the Sample payload data field when creating the parsing rule. The administrator can then create an expression that returns IP addresses from that sample in two formats: ipv4 and ipv6. In this example, the system produces two expressions to use for the parsing rule.

1. Navigate to Workflow > Workflow Editor and open the activity that runs on the host.
2. Click the Inputs tab, and note the Command.

3. In a PowerShell console, run the Command on the host to extract the XML sample that contains the values you need.
4. Copy the data that is returned to the clipboard.
5. In the activity designer, click the Outputs tab and paste the returned data into the Sample payload data field.
   In this example, the data includes IP addresses in two different formats and the domain name.

Parsing rule PowerShell inputs command
6. Select the parsing type for the source. In this example, select **XML**.
7. Click **Parse sample data**.

The system displays the XML in the proper format, and it becomes *clickable*. In this view, the system can translate clicked data from the sample into an expression.
8. To create the expression, click the elements in the data sample you want to map to the variable. Based on the sample data you clicked, the system creates two expressions.

```
<ip type="ipv4"> 10.0.2.15 </ip>
<ip type="ipv6"> fe80:1689:51a2:27fa:10b2 </ip>
<domain> corp.service-now.com </domain>
```
9. Select an expression from the list.

The desired result is the IP address that has a **type** attribute of **ipv4**. The system populates the **Expression** field with this choice.
10. Click **Test expression**.

The system parses the payload using the selected expression and returns the requested data in the **Parsing result** field.
11. Click **Submit**.

The view returns to the **Outputs** tab of the activity designer. The new parsing rule is listed, and a blank row is available for another rule.

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Description</th>
<th>Source</th>
<th>Parsing Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>activityOutput_inv4</td>
<td></td>
<td>executionResult_o</td>
<td>XML</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Parsing rules**

**Activity conditions**

Create the exit conditions for your activity in the **Condition** column and set the order for each.

The system evaluates the condition with the lowest order number first and stops when it finds the first true condition. The system delays evaluation of conditions with an **Else** value set to **true** until all conditions with an **Else** value set to **false** are evaluated. If the system does not find a true condition, it looks for a default condition in which the value for **Else** is **true** and takes this exit. You must have at least one default exit condition, or the activity hangs when the workflow runs.

The following are possible conditions you might create for an activity:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Evaluation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Tests for a success condition. <strong>Else</strong> is set to <strong>false</strong> and the <strong>Order</strong> is set to <strong>100</strong>. If this condition is true, the activity takes the <strong>Success</strong> exit. If this condition is false, the system evaluates the next condition in order.</td>
</tr>
<tr>
<td>Retry</td>
<td>Tests for a condition that runs the activity again. <strong>Else</strong> is set to <strong>false</strong>. If this condition is true, the activity runs again. If this condition is false, the system takes the default <strong>Failure</strong> exit.</td>
</tr>
<tr>
<td>Failure</td>
<td>Default condition that allows the workflow to continue if the other conditions in the activity are false. <strong>Else</strong> is set to <strong>true</strong>.</td>
</tr>
</tbody>
</table>
Orchestration custom activity templates

Orchestration provides customizable activity templates to create and manage custom activities in the Workflow Editor.

You create and update different types of Orchestration activities with the Activity Designer using activity templates for SSH, PowerShell, REST, SOAP, JMS, SFTP, JDBC, JavaScript Probes, and Probes.

Hundreds of workflows can share these activities simultaneously. Before you change an activity, you should check the workflows that they are part of by clicking the form menu icon and selecting Used In. Any central change to a versioned activity automatically updates across workflows unless you have pinned that activity.

All the Orchestration Core activities are built using the Activity Designer in scoped applications. Custom activities can be developed in the global scope or their own application scope even if that scope is different from the scope of the workflow. Use Activity scoping when build your own activity packs.

Create a JDBC activity

Create a custom JDBC activity to automate SQL commands and stored procedure calls to relational databases from workflow.

Role required: activity_admin, activity_creator

The JDBC activity template allows you to execute ANSI SQL statements or stored procedures on a target database. Support for stored procedures with IN, OUT, and INOUT parameters are available in New York. To learn how to set up these parameters, see JDBC stored procedure parameters.

Note: If you are transferring bulk data into a ServiceNow instance from an external data source, use Import sets. The JDBC activities allow you to transfer data between external data sources and ServiceNow within a workflow. It is not intended to replace the bulk import features of data sources.

1. Create or verify your JDBC credential.
Your JDBC credentials must have permission for the target database and proper configuration for the corresponding JDBC connection. Credentials must be set up before you can create a JDBC activity.

2. **Create or verify your JDBC connection.**
   Your JDBC connection must be configured with valid JDBC credentials set up before you can create a JDBC activity.

3. **Create a custom activity.**
   This action creates a custom activity using a template.

4. **After setting up general properties and creating input variables**, configure the JDBC Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| JDBC Connection | Configure or reference the appropriate JDBC Connection for the database. The connection selected provides the activity with the following information:  
• Target database information (server and database names)  
• Connection URL  
• Target database port (if different from standard port number)  
• Database instance name |
| Credential      | JDBC credential to use for your JDBC connection.                            |
| SQL statement   | Input the ANSI SQL to execute on the JDBC target database.                  |

**Note:** This field is hidden when the Stored Procedure check box is selected.

You can map the input variables you created to configure the SQL statements. By default, you can run the following SQL statements:

• select  
• insert  
• update  
• delete  
• show  
• create  
• describe

For added security measure, a MID Server property controls the operations that this JDBCOrchestrationProbe executes, which restricts the SQL commands used. This property protects against potentially destructive commands, such as drop database. The mid.property.jdbc_operations contains the MID Server property controls.

**Note:** You cannot run multiple statements of different types. For example, you cannot run a select statement and an update statement together, but you can run two insert statements. However, you cannot run multiple select statements in this activity.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum rows</td>
<td>Maximum number of records to retrieve from database. The default is 1000.</td>
</tr>
<tr>
<td>Maximum payload size (KB)</td>
<td>You can set a limit on the maximum payload size of data retrieved from the database. The default is 64 kilobytes.</td>
</tr>
<tr>
<td>Connection timeout</td>
<td>How long the activity waits to make the connection. This field is populated automatically from the data source, but can be changed for this activity.</td>
</tr>
<tr>
<td>Query timeout</td>
<td>Elapsed time to wait after running the query until the data is returned. This field is populated automatically from the data source, but can be changed for this activity.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server to use for querying JDBC, by capabilities. By default, the system selects a MID Server that has JDBC capability.</td>
</tr>
<tr>
<td>Use stored procedure</td>
<td>If checked, you can run a stored procedure on MySQL, Oracle, or SQL Server databases by entering the procedure name and parameters. See JDBC stored procedure parameters.</td>
</tr>
</tbody>
</table>

**Note:** You can map parameter values in a test payload to variables in the Outputs tab automatically. See automap output variables.

- Test JDBC activity inputs
- Use auto-mapping to generate outputs and parsing rules (recommended for JDBC)
- If you do not use auto-mapping, you can manually create output variables and create parsing rules

### Create a JDBC connection for an Orchestration activity

The JDBC Connection [jdbc_connection] table provides the information custom JDBC Orchestration activities use to connect to various target databases.

You must have an appropriate JAR file, whether it is supplied with the instance or a custom JAR file.

**Note:** The ServiceNow instance supplies mysql-connector-java-5.1.21.jar, sql-server-jdbc-4.0.jar, and ojdbc6.jar files as part of the current release, which supports MySQL, SQLServer, and Oracle databases. Other databases, such as Sybase or DB2 Universal, must use a custom JAR file that must be uploaded to the instance before setting the JDBC connection.

Role required: activity_admin, activity_creator

JDBC credentials are retrieved separately by the activity designer template and support external credential storage, such as CyberArk.

1. Navigate to **Orchestration > Credentials & Connections > JDBC Connections** and click **New**.
2. Complete the form using the fields in the table.
   The database selection in the **Format** field determines which fields are available.

**JDBC connection fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Database Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>All</td>
<td>Unique name of this JDBC connection. For example, you might enter <em>JDBC MySQLProd</em>.</td>
</tr>
<tr>
<td>Query timeout</td>
<td>All</td>
<td>Maximum elapsed time the JDBC query is allowed to run without a response.</td>
</tr>
<tr>
<td>Connection timeout</td>
<td>All</td>
<td>Maximum elapsed time for the JDBC activity to wait while attempting to connect to the target database.</td>
</tr>
<tr>
<td>Application</td>
<td>All</td>
<td>Scope for this table. By default, the JDBC Connection [jdbc_connection] table runs in the <strong>Global</strong> scope.</td>
</tr>
<tr>
<td>Domain</td>
<td>All</td>
<td>Domain for this table. By default, the JDBC Connection [jdbc_connection] table runs in the <strong>global</strong> domain.</td>
</tr>
<tr>
<td>Format</td>
<td>All</td>
<td>Database type for this connection. The default choices are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- MySQL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Oracle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- SQLServer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can add <strong>Sybase</strong> or <strong>DB2 Universal</strong> to the choice list by uploading the appropriate JDBC driver JAR file to the instance. Orchestration automatically recognizes these drivers when they are loaded into the system and adds them to this list.</td>
</tr>
<tr>
<td>Server</td>
<td>Oracle, MySQL, SQLServer</td>
<td>Host name or IP address of the database server.</td>
</tr>
<tr>
<td>Oracle sid</td>
<td>Oracle</td>
<td>The Oracle database site identifier. The default value is <em>orcl</em>.</td>
</tr>
<tr>
<td>Oracle port</td>
<td>Oracle</td>
<td>Port that the Oracle database is using. The default value is <em>1521</em>.</td>
</tr>
<tr>
<td>Database name</td>
<td>MySQL, SQLServer</td>
<td>Name of the database.</td>
</tr>
<tr>
<td>Database port</td>
<td>My SQL, SQLServer</td>
<td>Port that the selected database is using.</td>
</tr>
<tr>
<td>Instance name</td>
<td>SQLServer</td>
<td>Instance name for the selected SQLServer</td>
</tr>
<tr>
<td>Connection URL</td>
<td>All</td>
<td>URL that the MID Server uses to connect to the specified database. The URL is created automatically when you save the form, and is read-only for the default databases.</td>
</tr>
</tbody>
</table>

**Note:** If the format selected is not one of the default databases, you must create the connection URL manually so that the MID Server knows how to create the connection.
### JDBC connection to Oracle example

3. Click **Submit**.

*Auto-map JDBC activity output variables*

The ServiceNow activity designer allows you to map parameter values in a JDBC test payload to variables in the **Outputs** tab automatically.
Role required: admin

1. In the JDBC provider template form, select the **Inputs** tab.
2. Click **Test Activity** to test the input parameters.
   If you added actual values for the parameters and fields, the system runs those values against the specified target and returns the resulting payload. If you mapped input variables to fields and parameters, the system displays a dialog box for assigning test values to those variables.
3. Provide test values, if requested, and click **OK** to display the payload.
   The entire payload appears in the **Raw Output** tab of the Response form.

4. Select one of these auto-mapping options.
   - **Auto-Map to Local**: Directly maps values to a local variable for use within the activity.
   - **Auto-Map to Output**: Directly maps values to the output variable to pass to other activities in the workflow. Auto-mapping to an output variable creates an array of objects, each of which contains the column names from the query result.

### JDBC stored procedure parameters

You can use Orchestration to run a stored procedure on MySQL, Oracle DB, and MS-SQL databases.

There is support of multiple data types, with the following limitations:

- Only one result-set is returned.
- The order of input and output data types in the stored procedure parameters must match the activity definition.
- Binary, Blob, Varbinary, and LongBinary should be base64 encoded.
- Date, Time, and Timestamp have a specific format:
  - **Date format**: `yyyy-mm-dd`
    `yyyy-mm-dd` is the supported format.
  - **Time format**: `hh:mm:ss[.sss]`
    `hh:mm:ss[.sss]` is the supported format. Precision is in milliseconds only, microseconds or nanoseconds cannot be handled.
  - **Timestamp format**: `yyyy-mm-dd hh:mm:ss[.ffffff]`
    `yyyy-mm-dd hh:mm:ss[.ffffff]` is the supported format. Precision is to microseconds.

- ResultSet is the first result set coming back from database server.
- MS-SQL does not support INOUT parameters. If you use INOUT parameters, the Activity Template transparently maps them to OUT parameters.

---

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Note:** If you do not want to do a validation of data types in stored procedure parameters, like the legacy behavior, you set the glide.stored_proc.data_type.validation as false. See MID Server properties for more information.

### Stored procedure parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Type of stored procedure parameter. Supported parameters:</td>
</tr>
<tr>
<td></td>
<td>• IN</td>
</tr>
<tr>
<td></td>
<td>• OUT</td>
</tr>
<tr>
<td></td>
<td>• INOUT</td>
</tr>
<tr>
<td>Sql Type</td>
<td>A SQL data type. Supported data types:</td>
</tr>
<tr>
<td></td>
<td>• ARRAY</td>
</tr>
<tr>
<td></td>
<td>• BIGINT</td>
</tr>
<tr>
<td></td>
<td>• BINARY</td>
</tr>
<tr>
<td></td>
<td>• BIT</td>
</tr>
<tr>
<td></td>
<td>• BLOB</td>
</tr>
<tr>
<td></td>
<td>• CHAR</td>
</tr>
<tr>
<td></td>
<td>• CLOB</td>
</tr>
<tr>
<td></td>
<td>• DATE</td>
</tr>
<tr>
<td></td>
<td>• DECIMAL</td>
</tr>
<tr>
<td></td>
<td>• DISTINCT</td>
</tr>
<tr>
<td></td>
<td>• DOUBLE</td>
</tr>
<tr>
<td></td>
<td>• FLOAT</td>
</tr>
<tr>
<td></td>
<td>• INT</td>
</tr>
<tr>
<td></td>
<td>• INTEGER</td>
</tr>
<tr>
<td></td>
<td>• JAVA_OBJECT</td>
</tr>
<tr>
<td></td>
<td>• LONGVARBINARY</td>
</tr>
<tr>
<td></td>
<td>• LONGVARCHAR</td>
</tr>
<tr>
<td></td>
<td>• NULL</td>
</tr>
<tr>
<td></td>
<td>• NUMERIC</td>
</tr>
<tr>
<td></td>
<td>• OTHER</td>
</tr>
<tr>
<td></td>
<td>• REAL</td>
</tr>
<tr>
<td></td>
<td>• REF</td>
</tr>
<tr>
<td></td>
<td>• REF_CURSOR</td>
</tr>
<tr>
<td></td>
<td>• SMALLINT</td>
</tr>
<tr>
<td></td>
<td>• STRUCT</td>
</tr>
<tr>
<td></td>
<td>• TIME</td>
</tr>
<tr>
<td></td>
<td>• TIMESTAMP</td>
</tr>
<tr>
<td></td>
<td>• TINYINT</td>
</tr>
<tr>
<td></td>
<td>• VARBINARY</td>
</tr>
<tr>
<td></td>
<td>• VARCHAR</td>
</tr>
<tr>
<td>Name/Value</td>
<td>Name-value pairs to pass to the host. You can create these parameters manually, or drag and drop input variables into the parameter fields and assign a value.</td>
</tr>
</tbody>
</table>
**Note:** Not all database providers support the entire realm of JDBC data types. Reference your database reference manual to understand the supported datatypes for your installation.

*Test JDBC activity template inputs*

You can test the input parameters of a custom JDBC activity during its development without having to run the activity in a workflow context.

Create input variables and map them to fields in the Execution Command form or provide actual values for these fields. Role required: web_service_admin, activity_admin, activity_creator

This test executes only the input parameters against an endpoint and not the pre-processing or post-processing scripts. It is not necessary to check out the activity to test it.
Note: If you provide enough information for Orchestration to contact the endpoint or host and return data, you can test the input variables. You can test from any stage in the activity designer. Typically, the Execution Command stage is the point at which your inputs are ready for testing.

1. From the JDBC Execution Command, click **Test Inputs**.
   The list of input source variables appears. If you added default values for these variables, those values appear in the **Substitute Value** column. Mandatory variables are marked with a red star.

   **Note:** The test fails if the MID Server cannot be found or if it cannot connect to the target.

   ![Fill in your test values](image)

   **JDBC input test values**

   2. Filter the variable list with these controls:
      - **All Inputs**: Displays all input variables. This control is the default view.
      - **Mandatory Inputs**: Displays only mandatory variables.
      - **Inputs Without Defaults**: Shows input variables that do not have assigned default values.
3. Reset values as needed.
   - **Reset default values:** If values are present, this control replaces any test values set in this form with the default values.
   - **Clear values:** Clears all values in the input variable list, even if default values exist.
4. When your test values are configured correctly, click **OK**.
   The system runs the values for all the inputs configured against the specified target and returns the resulting payload. The buttons in the Response form display different views of the payload. The entire payload appears in the **Raw Output** window.
Response payload from inputs test

5. To map appropriate parameter values in the payload to variables in the Outputs stage automatically, select an auto-mapping option.

6.
7. Click the X in the upper right corner of the window to close it.

Create a SOAP web service activity

Use this template to create a custom SOAP activity.

Role required: web_service_admin, activity_admin, activity_creator

For instructions on using the activity template process flow, see create custom activities.

1. Create a custom activity.

This action creates a custom activity using a template.

2. After setting up general properties and creating input variables, configure the SOAP web service Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map the input variables</td>
<td>Use the variables you created to configure the command that Orchestration executes on the SOAP web service.</td>
</tr>
<tr>
<td>Web service message</td>
<td>Specify the SOAP web service message to use for this activity. If you need information on SOAP web services messages, see #unique_2332.</td>
</tr>
<tr>
<td>Web service message function</td>
<td>Specify the SOAP message function available in conjunction with the SOAP web service.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>If you enter an endpoint in this field, it overrides the endpoint URL configured in the SOAP message web service. Click the lock icon to open the input field and add the endpoint.</td>
</tr>
<tr>
<td>SOAP message parameters</td>
<td>Name-value pairs to pass to the SOAP endpoint. You can create these parameters manually, or drag input variables into the parameter fields and then assign a value. Parameters defined in the SOAP message that use $() can be assigned data from this activity template. Use the Additional attribute column to configure the system to not escape the text. By default, text sent to the SOAP message is escaped. The Name column is auto-populated if the users have provided variables using variable substitution in the SOAP message.</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>Check box that determines if a MID Server must be used to invoke the SOAP web service. If the SOAP web service message function defines a MID Server, that MID Server is used instead of the one selected here.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server with the appropriate capabilities for connecting to the SOAP endpoint. By default, the system selects a MID Server with SOAP capabilities. This field is available when the Use MID Server check box is selected.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Allowed duration of the SOAP web service request before it times out, in seconds. The default is 10.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Authentication</td>
<td>Determines what type of authentication is required for the endpoint. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use existing credentials in SOAP message:</strong> Uses credential definitions from the SOAP message definition.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with Basic Authentication credentials:</strong> Uses basic authentication credentials. Overrides the credentials in the SOAP message definition. Basic authentication credentials must be provisioned before they are available for selection.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with Certificate Authentication credentials:</strong> Overrides the credentials in the SOAP message definition with certificate authentication credentials.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with Both Basic and Certificate Authentication credentials:</strong> Overrides the credentials in the SOAP message definition with both basic authentication or certificate authentication credentials.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with WS-Security Username profile:</strong> Overrides the credentials in the SOAP message definition with credentials defined a WS Security Profile.</td>
</tr>
<tr>
<td></td>
<td><strong>Credentials</strong> Required REST endpoint basic authentication credentials. This field is available when <strong>Override with Basic Authentication credentials</strong> is selected in the Authentication field. Only basic authentication credentials appear in the selection list, which includes credentials stored on the instance and credential IDs from an external storage system. If you are using credentials stored in a CyberArk safe, you can override the default safe defined in the MID Server configuration file by adding the name of a different safe as a prefix to the credential ID, separated by a colon. For example, <strong>newsafe:orch-test-f5</strong>. See <strong>Configure the MID Server for CyberArk</strong> for details.</td>
</tr>
<tr>
<td></td>
<td><strong>Protocol Profile</strong> Protocol profile to use for authentication. This field is available when the authentication type is either Override with Certificate Authentication credentials or Override with Both Basic and Certificate Authentication credentials.</td>
</tr>
</tbody>
</table>

**Note:** You can map parameter values in a test payload to variables in the Outputs tab automatically. See automap output variables.

- **Use auto-mapping** to generate outputs and parsing rules (recommended for JDBC)
- If you do not use auto-mapping, you can manually create output variables and create parsing rules

**Auto-map SOAP activity output variables**
The ServiceNow activity designer allows you to map parameter values in a SOAP test payload to variables in the Outputs stage automatically.

Role required: web_service_admin, activity_admin, activity_creator
**Note:** You can test input variables from any stage in the activity designer if you have provided enough information for Orchestration to contact the endpoint and return data. Typically, the **Execution Command** stage is the point at which your inputs are ready for testing.

1. In the activity designer, proceed to the **Execution Command** stage.
2. Define an appropriate MID Server, if requested.
   The test fails if the MID Server cannot be found or if it cannot connect to the target.
3. Click **Test Activity** to test the input parameters.
   If you added actual values for the parameters and fields, the system runs those values against the specified target and returns the resulting payload. If you mapped input variables to fields and parameters, the system displays a dialog box for assigning test values to those variables.
4. Provide test values, if requested, and click **OK** to display the payload.
   The entire payload appears in the **Raw Output** tab of the Response form.

5. Select one of these auto-mapping options.
   - **Auto-Map to Local**: Directly maps values to a local variable for use within the activity.
   - **Auto-Map to Output**: Directly maps values to the output variable to pass to other activities in the workflow. Auto-mapping to an output variable creates an array of objects, each of which contains the column names from the query result.

Provide credentials to access a SOAP message WSDL

If the SOAP WSDL you are requesting in a test payload requires authentication, you must provide basic auth credentials in either the SOAP message or the SOAP activity.

**Role required:** web_service_admin, activity_admin, activity_creator

The ServiceNow instance only supports basic auth credentials for accessing a WSDL. If the SOAP function or the SOAP message does not provide these credentials, you must configure them in the SOAP activity template. Orchestration uses these priorities for deciding which basic authentication credentials to use:

- **SOAP message**: Credentials for a SOAP message are used if no other credentials are defined.
- **SOAP function**: Credentials for a SOAP function override the credentials configured for the SOAP message.
- **SOAP activity template**: Credentials for a SOAP activity template override both the SOAP function and SOAP message credentials.

1. Navigate to System Web Services > Outbound > SOAP Message.
2. Select the SOAP message you want the activity to use.
3. In the SOAP Message record, select the **Download WSDL** check box.
4. In the **Authentication type** field, select **Basic**.
   The **Basic auth profile** field appears.
5. Select the basic auth profile to use with this SOAP message.
6. Alternately, you can configure basic authentication credentials in Configure the SOAP execution command.
   
a) In the Authentication field, select **Override with Basic Authentication credentials**. The Credentials field appears.

b) Select the basic auth credentials to use to access the WSDL. This setting overrides any credentials configured in the SOAP message.

Override basic auth credentials
Configure the SOAP execution command
Use the input variables you created to configure the command that Orchestration executes on the SOAP endpoint.

Create the input variables you need in the Inputs form before you can advance to the Execution Command stage.

Role required: web_service_admin, activity_admin, activity_creator
**Note:** You can test the SOAP connection between the MID Server and the endpoint without having to run the activity in a workflow context. For details, see test template outputs.

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.
SOAP execution command
2. Complete the fields shown in the table.

**SOAP template execution command fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input variable builder. Create input variables to map to available fields.</td>
</tr>
<tr>
<td>Web service message</td>
<td>#unique_2340 to use for this activity. Users must have the web_service_admin role to configure this field.</td>
</tr>
<tr>
<td>Web service message function</td>
<td>SOAP message function to use for this activity. Users must have the web_service_admin role to configure this field.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>Endpoint URL for the SOAP web service this activity uses. Enter an endpoint in this field to override the endpoint configured in the SOAP message. Click the lock icon to open the input field.</td>
</tr>
<tr>
<td>SOAP message parameters</td>
<td>Name-value pairs to pass to the SOAP endpoint. You can create these parameters manually, or drag input variables into the parameter fields and then assign a value. Parameters defined in the SOAP message that use ${} can be assigned data from this activity template. Use the Additional attribute column to configure the system to not escape the text. By default, text sent to the SOAP message is escaped. The Name column is auto-populated if the users have provided variables using variable substitution in the SOAP message.</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>Check box that determines if a MID Server must be used to invoke the SOAP web service.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server with the appropriate capabilities for connecting to the SOAP endpoint. By default, the system selects a MID Server with SOAP capabilities. This field is available when the Use MID Server check box is selected.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Allowed duration of the SOAP web service request before it times out, in seconds. The default is 10.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Authentication</th>
<th>Determines what type of authentication is required for the endpoint. The options are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Use existing credentials in SOAP message</strong>: Uses credential definitions from the SOAP message definition.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with Basic Authentication credentials</strong>: Uses basic authentication credentials. Overrides the credentials in the SOAP message definition. Basic authentication credentials must be provisioned before they are available for selection.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with Certificate Authentication credentials</strong>: Overrides the credentials in the SOAP message definition with certificate authentication credentials.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with Both Basic and Certificate Authentication credentials</strong>: Overrides the credentials in the SOAP message definition with both basic authentication or certificate authentication credentials.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with WS-Security Username profile</strong>: Overrides the credentials in the SOAP message definition with credentials defined a WS Security Profile.</td>
</tr>
</tbody>
</table>

| Credentials | Required REST endpoint basic authentication credentials. This field is available when **Override with Basic Authentication credentials** is selected in the **Authentication** field. Only basic authentication credentials appear in the selection list, which includes credentials stored on the instance and credential IDs from an external storage system. If you are using credentials stored in a CyberArk safe, you can override the **default safe** defined in the MID Server configuration file by adding the name of a different safe as a prefix to the credential ID, separated by a colon. For example, `newsafe:orch-test-f5`. |

| Protocol Profile | Protocol profile to use for authentication. This field is available when the authentication type is either **Override with Certificate Authentication credentials** or **Override with Both Basic and Certificate Authentication credentials**. |

3. Click **Save**.
4. Click **Continue** to advance to the **Outputs** stage.

**SOAP template execution parameters**

You use execution parameters to create the input process script in the **Pre processing** form of the activity designer.

For descriptions of the SOAP web service command fields, see the table in **Configure the SOAP execution command**.
### SOAP execution parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web service message</td>
<td>web_service_message</td>
<td>Reference</td>
<td>The sys_id of the corresponding SOAP message.</td>
</tr>
<tr>
<td>Web service message function</td>
<td>web_service_message_function</td>
<td>Reference</td>
<td>The sys_id of the SOAP message function.</td>
</tr>
<tr>
<td>Web service endpoint</td>
<td>web_service_endpoint</td>
<td>String</td>
<td>URL of the SOAP endpoint.</td>
</tr>
<tr>
<td>Parameters</td>
<td>parameters</td>
<td>Array of JavaScript objects</td>
<td>Array of JavaScript objects, expressed with the <code>executionParam.</code> prefix. For instructions on creating arrays using this parameter, see Create a JavaScript array in a SOAP template.</td>
</tr>
<tr>
<td>Use mid server</td>
<td>use_mid_server</td>
<td>Boolean</td>
<td>When true, indicates that a MID Server is used.</td>
</tr>
<tr>
<td>MidCapabilities</td>
<td>midCapabilities</td>
<td>String (comma separated)</td>
<td>List of references to required MID Server capabilities.</td>
</tr>
<tr>
<td>Time out</td>
<td>time_out</td>
<td>String</td>
<td>Allowed duration of the SOAP web service request before it times out, in seconds. The default is 10.</td>
</tr>
<tr>
<td>ValueCapabilities</td>
<td>valueCapabilities</td>
<td>Array of hashmap</td>
<td>Capability values used to select the MID Server. For more information, see MID Server capabilities. Use this example to customize the MID Server selection if there are additional capabilities that are assigned by value:</td>
</tr>
</tbody>
</table>

```javascript
var valueCapability = {
    'NEW_MID_CAPACITY': 'NEW_MID_CAPACITY_VALUE'
};
executionParam.valueCapabilities.push(valueCapability);
```
Create a JavaScript array in a SOAP template

These are instructions for creating JavaScript arrays using SOAP execution parameters.

Role required: web_service_admin, activity_admin, activity_creator

To add more name-value pairs to the parameter’s array, append the values to the existing array.

1. Create a JavaScript object with the following syntax, and add it to the executionParam.parameter array:

```javascript
var newParameter = {
  "name": "parameterName",
  "value": "parameterValue",
  "additional_attribute": "none"
};
exectionParam.parameters.push(newParameter);
```

By adding the new parameter JavaScript object to the array, you ensure that any elements already available in the array are not impacted.

2. Make sure to set the value in the Additional attribute column in the SOAP message parameters input field to Do not escape text.

In this case, the system does not escape the value specified for the value attribute. An example of this is:

```javascript
var newParameter = {
  "name": "parameterName",
  "value": "parameterValue",
  "additional_attribute": "do_not_escape_text"
};
exectionParam.parameters.push(newParameter);
```

>Note: If the value for the additional_attribute field is None, then the system escapes the value specified by the value attribute. In the first example, parameterValue is escaped.

SOAP template post-processing parameters

Use these parameters to create a post-processing script.

Activity designer post-processing parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status code</td>
<td>status_code</td>
<td>Integer</td>
<td>Contains the status code returned from the web service.</td>
</tr>
</tbody>
</table>
Create a JavaScript Probe activity

Create a JavaScript Probe activity to instruct a MID server to execute server-side javascript.

Role required: activity_creator or workflow_admin

The JavascriptProbe activity has the same functionality as making ‘Packages’ calls into standard Java libraries. It allows you to have more control over the Java libraries on the MID Server. You can load your own JAR files on the MID Server and have the JavascriptProbe make Package calls into those java files.

1. Create a custom activity.
   This action creates a custom activity using a template.

2. After setting up general properties and creating input variables, configure the JavaScript probe activity

   **Execution Command:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map the input variables</td>
<td>Use the variables you created to configure the command that Orchestration executes on the MID server.</td>
</tr>
</tbody>
</table>

   **Script type**

   Select the type of script to include. Available options are:
   - Custom JavaScript
   - MID Server script include

   **Script**

   Custom JavaScript to run with this probe.

   **MID Server script include**

   Script for the MID Server to run with this probe.

   **Select MID Server by host**

   MID Server on which the probe runs.

   **Required MID Server capabilities**

   MID Server to use, by capabilities.
Option | Description
-------|---------------------------------------------------
**Parameters** | Name-value pairs to pass to the host with this probe. You can create these parameters manually, or drag input variables into the Parameters fields and assign a value.

**Note:** You can map parameter values in a test payload to variables in the Outputs tab automatically. See automap output variables.

Finish creating your JavaScript probe activity by creating output variables, creating a parsing rule, or creating template conditions. Refer to the create custom activities topic to know your template options.

**JavaScript probe template execution parameters**
You use execution parameters to create the input process script in the Preprocessing form of the activity designer.

For descriptions of the JavaScript Probe command fields, see the table in Configure the JavaScript Probe execution command.

**Note:** You must use the `executionParam.` prefix with all variables in this table.

<table>
<thead>
<tr>
<th><strong>JavaScript template execution parameters</strong></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script Type</td>
<td>script_type</td>
<td>Enumerated</td>
<td>Type of script to run. The possible types are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• custom_javascript_type</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• mid_script_include_type</td>
</tr>
<tr>
<td>Script</td>
<td>script</td>
<td>String</td>
<td>Script that runs custom JavaScript when the script_type is</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>custom_javascript_type</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>mid_script_include_type</td>
</tr>
<tr>
<td>Mid script include</td>
<td>mid_script_include</td>
<td>Reference</td>
<td>The sys_id reference associated with the MID Server script include to</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>call, when the script_type is mid_script_include_type</td>
</tr>
<tr>
<td>Source</td>
<td>source</td>
<td>String</td>
<td>Target host on which to run the script.</td>
</tr>
<tr>
<td>MidCapabilities</td>
<td>midCapabilities</td>
<td>String (comma separated)</td>
<td>List of required MID Server capabilities.</td>
</tr>
</tbody>
</table>
### ServiceNow Platform capabilities

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
</table>
| Parameters       | parameters | Array of JavaScript object | Array of JavaScript objects, expressed with the executionParam. prefix. To add more name-value pairs to the `parameters` array, append them to the existing array. Create a JavaScript object with the following syntax, and add it to the `executionParam.parameter` array. This assigns additional parameters to the message:  

```javascript
var newParameter = {
    "name": "parameterName",
    "value": "parameterValue"
}
executionParam.parameters.push(newParameter);
```

| ValueCapabilities | valueCapabilities | Array of hashmap | Capability values used to select the MID Server. For more information, see MID Server capabilities. If there are additional capabilities that are assigned by value, use this example to customize the MID Server selection:  

```javascript
var valueCapability = {
    "NEW_MID_CAPACITY": "NEW_MID_CAPACITY_VALUE"
}
executionParam.valueCapabilities.push(valueCapability);
```

---

**JavaScript probe template post-processing parameters**

Use these parameters to create a post-processing script.

**JavaScript probe post-processing parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payload</td>
<td>payload</td>
<td>String</td>
<td>Contains raw payload returned from the JavaScript Probe.</td>
</tr>
<tr>
<td>Output</td>
<td>output</td>
<td>String</td>
<td>Contains output data returned from the JavaScript Probe.</td>
</tr>
<tr>
<td>Name</td>
<td>Variable</td>
<td>Type</td>
<td>Usage</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------</td>
<td>--------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>EccSysId</td>
<td>eccSysId</td>
<td>String</td>
<td>Contains the reference ID associated with the ECC Queue input message.</td>
</tr>
<tr>
<td>Error Messages</td>
<td>errorMessages</td>
<td>String</td>
<td>Contains the error messages returned from the JavaScript probe. If no error messages are returned, this value is null.</td>
</tr>
</tbody>
</table>

---

**Configure the JavaScript Probe execution command**

Use the input variables you created to configure the command that Orchestration executes on the JavaScript Probe target host.

Create the input variables you need in the **Inputs** form before you can advance to the **Execution Command** stage.

Role required: activity_creator, admin
**Note:** You can test the JavaScript Probe connection between the MID Server and the target without having to run the activity in a workflow context. For details, see test template outputs.

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.
2. Complete the fields shown in the table.

### JavaScript Probe execution command fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input variable builder. <a href="#">Create input variables</a> to map to available fields.</td>
</tr>
<tr>
<td>Script type</td>
<td>Select the type of script to include. Available options are:</td>
</tr>
<tr>
<td></td>
<td>• Custom JavaScript</td>
</tr>
<tr>
<td></td>
<td>• MID Server script include</td>
</tr>
<tr>
<td>Script</td>
<td>Custom JavaScript to run with this probe. This field is available when the Script type selected is Custom JavaScript.</td>
</tr>
<tr>
<td>MID Server script include</td>
<td>Script for the MID Server to run with this probe. This field is available when the Script type selected is MID Server script include.</td>
</tr>
<tr>
<td>Select MID Server by host</td>
<td>MID Server on which the probe runs.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server to use, by capabilities.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Name-value pairs to pass to the host with this probe. You can create these parameters manually, or drag input variables into the Parameters fields and assign a value.</td>
</tr>
</tbody>
</table>

3. Click **Save**.
4. Click **Continue** to advance to the **Outputs** stage.

### Create a PowerShell activity

Create a custom PowerShell activity return data to a workflow from a host using Microsoft PowerShell.

Role required: activity_creator or workflow_admin

ServiceNow supports PowerShell 2.0 and above. PowerShell 3.0 does not support Windows 2003 Server.

1. Create a custom activity.
   - This action creates a custom activity using a template.
2. After setting up **general properties** and **creating input variables**, configure the PowerShell Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map the input variables</td>
<td>Use the variables you created to configure the command that Orchestration executes on the MID Server.</td>
</tr>
<tr>
<td>Target host</td>
<td>Host name or IP address of the target server for this PowerShell activity.</td>
</tr>
<tr>
<td>Script type</td>
<td>Type of PowerShell script to run on the PowerShell host. Available options are:</td>
</tr>
<tr>
<td></td>
<td>• Custom PowerShell command</td>
</tr>
<tr>
<td></td>
<td>• MID Server script file</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MID Server script file</td>
<td>The MID Server script file contains the PowerShell scripts. This field is available when the Script type selected is MID Server script file.</td>
</tr>
<tr>
<td>Command</td>
<td>PowerShell command the activity executes. This field is available when the Script type selected is Custom PowerShell command. You can create your commands by dragging and dropping input variables from the variable builder into this field.</td>
</tr>
<tr>
<td>PowerShell variables</td>
<td>Name-value pairs to pass to the host with PowerShell. You can create these variables manually, or drag input variables into the Value field. Encrypted input variables retain their encryption, regardless of the data type settings in this field. If you type in a value and select the Encrypted data type, your value appears in plain text. It is only encrypted when it passes to the ECC Queue.</td>
</tr>
<tr>
<td>Use MID Service Account</td>
<td>If checked, this activity authenticates on the target host using the credentials of the MID Server service account only, without trying any other credentials.</td>
</tr>
<tr>
<td>Note: The Credential tag field is not available.</td>
<td></td>
</tr>
<tr>
<td>Credential tag</td>
<td>Credential tag this activity must use to run PowerShell commands on the host. If this field is left blank, the MID Server tries all the available credentials until it finds a valid one, ending with the MID Server service account. If a credential tag is defined, the MID Server tries the credentials with that tag specified only and does not try the MID Server service account.</td>
</tr>
<tr>
<td>Note: This field is not available when the Use MID service account check box is selected.</td>
<td></td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server to use for querying PowerShell, by capabilities. By default, the system selects a PowerShell MID Server.</td>
</tr>
<tr>
<td>Note: You can map parameter values in a test payload to variables in the Outputs tab automatically. See automap output variables.</td>
<td></td>
</tr>
</tbody>
</table>

Finish creating your PowerShell activity by creating output variables, creating a parsing rule, or creating template conditions. Refer to the create custom activities topic to know your template options.

**PowerShell template execution parameters**

You use execution parameters to create the input process script in the Pre Processing form of the activity designer.

For descriptions of the Powershell command fields, see the table in Configure the PowerShell execution command.

**Note:** You must use the `executionParam.` prefix with all variables in this table.
## Powershell execution parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>source</td>
<td>String</td>
<td>Target host on which to execute the command.</td>
</tr>
<tr>
<td>Script type</td>
<td>script_type</td>
<td>Enumeration</td>
<td>Type of script to run. The possible types are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- command: Custom PowerShell command.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- file: Identifies the MID Server script file to run.</td>
</tr>
<tr>
<td>Command</td>
<td>command</td>
<td>String</td>
<td>Command sent to the MID Server for it to run on the target host.</td>
</tr>
<tr>
<td>MidScriptFile</td>
<td>midScriptFile</td>
<td>Reference</td>
<td>Reference sys_id of the MID Server script file to execute, when the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>script_type is file.</td>
</tr>
<tr>
<td>PowershellVariables</td>
<td>powershellVariables</td>
<td>Array of hashmap</td>
<td>Hashmap of JavaScript objects with name, value, and type for each object. The type of each object can be one of plain, encrypted, boolean, or null, corresponding to the PowerShell variable type selected in the inputs tab. For example, you might enter:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>var newParameter = { &quot;name&quot;: &quot;parameterName&quot;, &quot;value&quot;: &quot;parameterValue&quot;, &quot;type&quot;: &quot;plain&quot; }; executionParam.powershellVariables.push(newParameter);</td>
</tr>
<tr>
<td>Credential tag</td>
<td>credential_tag</td>
<td>String</td>
<td>Specific credential tag this activity must use to run PowerShell commands on the host.</td>
</tr>
<tr>
<td>MidCapabilities</td>
<td>midCapabilities</td>
<td>String (comma separated)</td>
<td>List of required MID Server capabilities.</td>
</tr>
<tr>
<td>Name</td>
<td>Variable</td>
<td>Type</td>
<td>Usage</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| ValueCapabilities| valueCapabilities | Array of hashmap | Capability values used to select the MID Server. For more information, see MID Server capabilities. If there are additional capabilities that are assigned by value, use this example to customize the MID Server selection:

```javascript
var valueCapability = {
  'NEW_MID_CAPABILITY': 'NEW_MID_CAPABILITY_VALUE'
};
executionParam.valueCapabilities.push(valueCapability);
```

### Powershell post-processing parameters and payload parsing

Use these parameters to create a post-processing script, payload parsing, and tagging.
## Powershell post-processing parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tags</td>
<td>tags</td>
<td>Hashmap of tag values to return from the PowerShell command.</td>
<td></td>
</tr>
<tr>
<td>Hresult</td>
<td>hresult</td>
<td>String</td>
<td>Contains any hresult returned from the PowerShell command. If no hresult is returned, this parameter is null.</td>
</tr>
<tr>
<td>Output</td>
<td>output</td>
<td>String</td>
<td>Contains the raw output from the PowerShell command.</td>
</tr>
<tr>
<td>EccSysID</td>
<td>eccSysID</td>
<td>String</td>
<td>Contains the reference ID associated with the ECC Queue input message returned by the activity.</td>
</tr>
</tbody>
</table>

**Tags**

Contains the tags used to extract output using the PowerShell commands. The tag output is delimited by double percentage signs, as in ```%tagname%%``` ... ```%```. Set up the command using the format in this example:

```powershell
Write-Host %
%tagname1%
output1 line 1
output1 line 2
...
Write-Host%
Write-Host %
%tagname2%
output2 line 1
output2 line 2
...
Write-Host%```

The tags returned are JavaScript hashmap objects in which each key is prefixed with `tag` appended with the `tagname`.

```json
{"__text__":
""
,"tagtagname1":"output1\nl
output1\nl
line1\noutput1\nl
line2\n",
,"tagtagname2":"output2\nl
output2\nl
line1\noutput2\nl
line2\n"}
```
Create a REST web service activity

Use this procedure to create a custom REST web service Orchestration activity.

Role required: web_service_admin, activity_admin, activity_creator

To create and use a REST web service workflow activity:

- Create a REST message if an appropriate one is not already configured.
- Assign the web_service_admin role to any user who must create or edit a custom REST activity.
- Determine an application, or scope, for this activity.
- Determine the REST endpoint to use for the activity. Use this value to override the endpoint configured in the REST message.
- Optionally, create basic authentication credentials. Use this value to override the credentials configured in the SOAP message.

1. Create a custom activity.
   
   This action creates a custom activity using a template.

2. After setting up general properties and creating input variables, configure the REST web service Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map the input variables</td>
<td>Use the variables you created to configure the command that Orchestration executes.</td>
</tr>
<tr>
<td>REST message</td>
<td>Name of an existing REST message to use in this activity.</td>
</tr>
<tr>
<td>REST message function</td>
<td>REST message function to use for this activity.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>Endpoint URL for the REST web service this activity uses. Enter an endpoint in this field to override the endpoint configured in the REST message. Click the lock to open the input field.</td>
</tr>
<tr>
<td>Variable substitutions</td>
<td>Name-value pairs to pass to the REST endpoint. You can create these parameters manually, or drag input variables into the parameter fields, and then assign a value. Parameters defined in the REST message that use ${} can be assigned data from this activity template. Use the Additional attribute column to configure the system to not escape the text. By default the text sent to the REST message is escaped. If the users have provided variables using variable substitution in the REST message, then the Name column is automatically populated.</td>
</tr>
<tr>
<td>Additional Headers</td>
<td>Additional HTTP header parameters for the REST message selected. You can also use these values to override parameters inherited from the REST message.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Additional Query Parameters</strong></td>
<td>Additional query parameters for the REST message selected. You can also use these values to override parameters inherited from the REST message.</td>
</tr>
<tr>
<td><strong>Use MID Server</strong></td>
<td>Check box that determines if a MID Server should be used to invoke the REST web service.</td>
</tr>
<tr>
<td><strong>Required MID Server capabilities</strong></td>
<td>MID Server with the appropriate capabilities for connecting to the REST endpoint. By default, the system selects a MID Server with REST capabilities. This field is available when the Use MID Server check box is selected.</td>
</tr>
<tr>
<td><strong>Timeout</strong></td>
<td>Allowed duration of the REST web service request before it times out, in seconds. The default is 10.</td>
</tr>
<tr>
<td><strong>Authentication</strong></td>
<td>Determines what type of authentication is required for the endpoint. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use existing credentials in REST message</strong>: Uses credential definitions from the REST message definition.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with Basic Authentication credentials</strong>: Uses basic authentication credentials to override the credentials in the REST message definition. Basic authentication credentials must be provisioned before they are available for selection.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with Certificate Authentication credentials</strong>: Uses a certificate, such as a private key, to override the credentials in the REST message definition.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with Both Basic and Certificate Authentication credentials</strong>: Uses both basic authentication and certificate authentication to override the credentials in the REST message definition.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Override with OAuth Authentication credentials</strong>: Uses OAuth 2.0 credentials to override the credentials in the REST message definition. The REST message selected for this activity must have its Authentication type set to OAuth 2.0 and its OAuth profile configured appropriately.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Credentials</strong></td>
<td>Required REST endpoint basic authentication credentials. This field is available when <strong>Override with Basic Authentication credentials</strong> is selected in the <strong>Authentication</strong> field. Only basic authentication credentials appear in the selection list, which includes credentials stored on the instance and credential IDs from an external storage system. If you are using credentials stored in a CyberArk safe, you can override the default safe defined in the MID Server configuration file. See Configure the MID Server for CyberArk for details. Add the name of a different safe as a prefix to the credential ID, separated by a colon. For example, newsafe:orch-test-f5.</td>
</tr>
<tr>
<td><strong>Protocol Profile</strong></td>
<td>Certificate authentication to use. This field is available when the selections in the <strong>Authentication</strong> are either <strong>Override with Certificate Authentication credentials</strong> or <strong>Override with Both Basic and Certificate Authentication credentials</strong>.</td>
</tr>
<tr>
<td><strong>OAuth profile</strong></td>
<td>Profile for the OAuth provider for this REST message. See #unique_2354 for more information.</td>
</tr>
</tbody>
</table>

**Note:** You can map parameter values in a test payload to variables in the **Outputs** tab automatically. See automap output variables.

Finish creating your Rest web service activity by creating output variables, creating a parsing rule, or creating template conditions. Refer to the create custom activities topic to know your template options.

**Auto-map REST activity output variables**

The ServiceNow activity designer allows you to map parameter values in a REST test payload to variables in the **Outputs** stage automatically.

Role required: web_service_admin, activity_admin, activity_creator

**Note:** You can test input variables from any stage in the activity designer if you have provided enough information for Orchestration to contact the endpoint and return data. Typically, the **Execution Command** stage is the point at which your inputs are ready for testing.

1. In the activity designer, proceed to the **Execution Command** stage.
2. Define an appropriate MID Server, if requested.
   The test fails if the MID Server cannot be found or if it cannot connect to the target.
3. Click **Test Activity** to test the input parameters.
   If you added actual values for the parameters and fields, the system runs those values against the specified target and returns the resulting payload. If you mapped input variables to fields and parameters, the system displays a dialog box for assigning test values to those variables.
4. Provide test values, if requested, and click OK to display the payload.
   The entire payload appears in the **Raw Output** tab of the Response form.

   ![Response Form](image)

5. Select one of these auto-mapping options.
   - **Auto-Map to Local**: Directly maps values to a local variable for use within the activity.
   - **Auto-Map to Output**: Directly maps values to the output variable to pass to other activities in the workflow. Auto-mapping to an output variable creates an array of objects, each of which contains the column names from the query result.

**REST template execution parameters**

You use execution parameters to create the input process script in the **Pre Processing** form of the activity designer.

For descriptions of the REST web service command fields, see [Configure the REST execution command](#).

**Note**: You must use the `executionParam.` prefix with all variables in this table.

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web service message</td>
<td>web_service_message</td>
<td>Reference</td>
<td>The sys_id of the corresponding web service message.</td>
</tr>
<tr>
<td>Web service message function</td>
<td>web_service_message_function</td>
<td>Reference</td>
<td>The sys_id of the REST message function.</td>
</tr>
<tr>
<td>Web service endpoint</td>
<td>web_service_endpoint</td>
<td>String</td>
<td>URL of the REST endpoint.</td>
</tr>
<tr>
<td>Parameters</td>
<td>parameters</td>
<td>Array of JavaScript objects</td>
<td>Array of JavaScript objects, expressed with the <code>executionParam.</code> prefix. For instructions on creating arrays using this parameter see <a href="#">Create a JavaScript array in a REST template</a>.</td>
</tr>
<tr>
<td>Name</td>
<td>Variable</td>
<td>Type</td>
<td>Usage</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use mid server</td>
<td>use_mid_server</td>
<td>Boolean</td>
<td>Selects whether or not to use the MID Server. A value of true uses the MID Server, and a value of false does not use the MID Server.</td>
</tr>
<tr>
<td>MidCapabilities</td>
<td>midCapabilities</td>
<td>String (comma separated)</td>
<td>List of references to required MID Server capabilities.</td>
</tr>
<tr>
<td>Time out</td>
<td>time-out</td>
<td>String</td>
<td>Allowable time out duration, expressed in seconds.</td>
</tr>
<tr>
<td>ValueCapabilities</td>
<td>valueCapabilities</td>
<td>Array of hashmap</td>
<td>Capability values used to select the MID Server. For more information, see MID Server capabilities. Use this example to customize the MID Server selection if there are additional capabilities that are assigned by value:</td>
</tr>
<tr>
<td>auth-type</td>
<td>auth-type</td>
<td>Boolean</td>
<td>Type of credentials to use. The choices are: basic_auth_pick_credentials, use_existing_credentials</td>
</tr>
<tr>
<td>Credentials</td>
<td>credentials</td>
<td>Reference</td>
<td>Contains the credentials to use for this REST message when the auth_type selected is basic_auth_pick_credentials.</td>
</tr>
</tbody>
</table>

**Create a JavaScript array in a REST template**

These are instructions for creating JavaScript arrays using REST execution parameters.

**Role required:** web_service_admin, activity_admin, activity_creator

To add more name-value pairs to the parameter's array, append the values to the existing array.

1. Create a JavaScript object with the following syntax, and add it to the `executionParam.parameter` array:

   ```javascript
   var newParameter = {
     "name":"parameterName","value":"parameterValue","additional_attribute":"none"};
   ```

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
By adding the new parameter JavaScript object to the array, you ensure that any elements already available in the array are not impacted.

2. Make sure to set the value in the Additional attribute column in the REST message parameters input field to Do not escape text.

In this case, the system does not escape the value specified for the value attribute. An example of this is:

```javascript
var newParameter = {
  "name": "parameterName",
  "value": "parameterValue",
  "additional_attribute": "do_not_escape_text"
};
executionParam.parameters.push(newParameter);
```

**Note:** If the value for the additional_attribute field is None, then the system escapes the value specified by the value attribute. In the first example, parameterValue is escaped.

**REST template post-processing parameters**

Use these parameters to create a post-processing script.

### Activity designer post-processing parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status code</td>
<td>status_code</td>
<td>Integer</td>
<td>Contains the status code returned from the REST web service.</td>
</tr>
<tr>
<td>Header</td>
<td>header</td>
<td>Hashmap of JavaScript object</td>
<td>Hashmap of key value pairs associated with the header values passed into the web service. You can access each value with <code>executionResult.header[keyName]</code>.</td>
</tr>
<tr>
<td>Body</td>
<td>body</td>
<td>String</td>
<td>Contains a string value representing the output from the REST message</td>
</tr>
<tr>
<td>Error</td>
<td>error</td>
<td>String</td>
<td>Returns the error string from the REST web service, unless there are no errors, in which case it returns null.</td>
</tr>
</tbody>
</table>

**Configure the REST execution command**

Use the input variables you created to configure the command that Orchestration executes on the REST endpoint.

Create the input variables you need in the Inputs form before you can advance to the Execution Command stage.

Role required: web_service_admin, activity_admin, activity_creator
Note: You can test the REST connection between the MID Server and the endpoint without having to run the activity in a workflow context. For details, see test template outputs.

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.
ServiceNow™ DocVersion™ Now Platform capabilities

---

Drag variable from the left to template fields below to create associations to the template inputs below.

- REST Message
  - Yahoo Finance
    - REST Message
      - Yahoo Finance [get]
2. Complete the fields shown in the table.

**REST execution command fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input variable builder. <a href="#">Create input variables</a> to map to available fields.</td>
</tr>
<tr>
<td>REST message</td>
<td>Name of an existing REST message to use in this activity. Users must have the web_service_admin role to configure this field.</td>
</tr>
<tr>
<td>REST message function</td>
<td>REST message function to use for this activity. Users must have the web_service_admin role to configure this field.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>Endpoint URL for the REST web service this activity uses. Enter an endpoint in this field to override the endpoint configured in the REST message. Click the lock to open the input field.</td>
</tr>
<tr>
<td>Variable substitutions</td>
<td>Name-value pairs to pass to the REST endpoint. You can create these parameters manually, or drag and drop input variables into the parameter fields, and then assign a value. Parameters defined in the REST message that use <code>${}</code> can be assigned data from this activity template. Use the Additional attribute column to configure the system to not escape the text. By default the text sent to the REST message is escaped. The Name column is automatically populated if the users have provided variables using variable substitution in the REST message.</td>
</tr>
<tr>
<td>Additional Headers</td>
<td>Additional HTTP header parameters for the REST message selected. You can also use these values to override parameters inherited from the REST message.</td>
</tr>
<tr>
<td>Additional Query Parameters</td>
<td>Additional query parameters for the REST message selected. You can also use these values to override parameters inherited from the REST message.</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>Check box that determines if a MID Server should be used to invoke the REST web service.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server with the appropriate <a href="#">capabilities</a> for connecting to the REST endpoint. By default, the system selects a MID Server with REST capabilities. This field is available when the Use MID Server check box is selected.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Allowed duration of the REST web service request before it times out, in seconds. The default is 10.</td>
</tr>
</tbody>
</table>

---

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication</td>
<td>Determines what type of authentication is required for the endpoint. The options are:</td>
</tr>
<tr>
<td></td>
<td>• Use existing credentials in REST message: Uses credential definitions from the REST message definition.</td>
</tr>
<tr>
<td></td>
<td>• Override with Basic Authentication credentials: Uses basic authentication credentials to override the credentials in the REST message definition. Basic authentication credentials must be provisioned before they are available for selection.</td>
</tr>
<tr>
<td></td>
<td>• Override with Certificate Authentication credentials: Uses a certificate, such as a private key, to override the credentials in the REST message definition.</td>
</tr>
<tr>
<td></td>
<td>• Override with Both Basic and Certificate Authentication credentials: Uses both basic authentication and certificate authentication to override the credentials in the REST message definition.</td>
</tr>
<tr>
<td></td>
<td>• Override with OAuth Authentication credentials: Uses OAuth 2.0 credentials to override the credentials in the REST message definition. The REST message selected for this activity must have its Authentication type set to OAuth 2.0 and its OAuth profile configured appropriately.</td>
</tr>
<tr>
<td>Credentials</td>
<td>Required REST endpoint basic authentication credentials. This field is available when Override with Basic Authentication credentials is selected in the Authentication field. Only basic authentication credentials appear in the selection list, which includes credentials stored on the instance and credential IDs from an external storage system. If you are using credentials stored in a CyberArk safe, you can override the default safe defined in the MID Server configuration file by adding the name of a different safe as a prefix to the credential ID, separated by a colon. For example, newsafe:orch-test-f5.</td>
</tr>
<tr>
<td>Protocol Profile</td>
<td>Certificate authentication to use. This field is available when the selections in the Authentication field is either Override with Certificate Authentication credentials or Override with Both Basic and Certificate Authentication credentials.</td>
</tr>
<tr>
<td>OAuth profile</td>
<td>Profile for the OAuth provider for this REST message. See #unique_2354 for more information.</td>
</tr>
</tbody>
</table>

3. Click **Save**.
4. Click **Continue** to advance to the **Outputs** stage.
Create an SFTP activity

Create an activity that executes basic SFTP commands on a remote server.

Roles required: activity_creator or workflow_admin

You can create a custom activity that manages files and directories on a target host or copies a file from one SFTP server to another. The file content is streamed through a MID Server, which avoids having to store the data on the hard drive of the MID Server host machine.

**Note:** This activity requires the credentials of a user who can execute SFTP commands on the source host. The Copy File activity, provided in the activity pack, requires separate credentials to access the target host.

1. **Create a custom activity.**
   This action creates a custom activity using a template.

2. After setting up general properties and creating input variables, configure the SFTP Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Command</strong></td>
<td>Type of activity to create. The choices are:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td></td>
<td>• Create directory</td>
</tr>
<tr>
<td></td>
<td>• Get file list</td>
</tr>
<tr>
<td></td>
<td>• Remove file or directory</td>
</tr>
<tr>
<td></td>
<td>• Rename file or directory</td>
</tr>
<tr>
<td></td>
<td>• Set file attributes</td>
</tr>
</tbody>
</table>

**Note:** The fields that display on the form depend on the command you select.

<table>
<thead>
<tr>
<th><strong>Source host</strong></th>
<th>Name or IP address of the server containing the files targeted by the activity.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source port</strong></td>
<td>Port number to use to communicate with the source server. The default port number is 22.</td>
</tr>
<tr>
<td><strong>Source file path</strong></td>
<td>Full path to a file (/temp/test_data_file.txt) or directory (/temp/test_dir) on a source host depending on the selected command. Field available on following commands:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td></td>
<td>• Remove file or directory</td>
</tr>
<tr>
<td></td>
<td>• Set file attributes</td>
</tr>
<tr>
<td><strong>Source directory</strong></td>
<td>Path to the directory where the source files are located. Field available on following commands:</td>
</tr>
<tr>
<td></td>
<td>• Create directory</td>
</tr>
<tr>
<td></td>
<td>• Get file list</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source files</td>
<td>Names of specific source files to include in the file transfer. Separate the file names with semi-colons. This field supports a semi-colon separated list of wildcard patterns. For example: <code>*.txt; a?cd.pdf</code>. If this field is blank, all files are included. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Get file list</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For information about how the values in this field affect options in other fields, see the logic explanation which follows.</td>
</tr>
<tr>
<td>Is a directory</td>
<td>If checked, specifies the file path is a directory. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Remove file or directory</td>
</tr>
<tr>
<td>Credential tag for source</td>
<td>Specific credential tag this activity must use to run SFTP commands on the source host.</td>
</tr>
<tr>
<td>Credential tag for target</td>
<td>Specific credential tag this activity must use to run SFTP commands on the target host. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td>Excluded files</td>
<td>Names of specific source files to exclude from the file transfer. The activity acts on all other files found in the source directory or subfolders. Separate the file names with commas. This field supports comma-separated list of wildcard patterns. For example: <code>*.txt, a?cd.pdf</code>. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Get file list</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For information about how the values in this field affect options in other fields, see the logic explanation which follows.</td>
</tr>
<tr>
<td>Include subfolders</td>
<td>If checked, includes the files from subfolders in the source directory. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Get file list</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For information about how your selection affects other fields in the form, see the logic explanation which follows.</td>
</tr>
<tr>
<td>Target host</td>
<td>Name or IP address of the server to which the files are being transferred. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Target port</strong></td>
<td>Port number to use to communicate with the target host. The default port number is 22. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td><strong>Target file path</strong></td>
<td>Full path to a file on a target host. Field available on following commands:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td></td>
<td>• Rename file or directory</td>
</tr>
<tr>
<td><strong>Suffix for temporary file</strong></td>
<td>If a file exists on a target host, this command enables a temporary suffix to use for a file name. If this field contains a value, the activity first copies the source file to a temporary file on the target host using <code>targetFilePath + tempFileSuffix</code> as the name. Upon completion, the activity renames the file to the actual target file name. If this field is blank, the activity copies the source file directly to the target file and overwrites it, if it exists. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td><strong>UID</strong></td>
<td>User ID attribute to apply to a file or directory. The UID and GID values must be set together as a pair or they are ignored. The UID and GID numbers are internal values returned by the Get File List activity. Typically, you first use the Get File List activity to return a list of files and their attributes. Then you can move a file from a source host to a target host and set the source file attributes on the target file. This flow is demonstrated in the SFTP File Transfer workflow. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Set file attributes</td>
</tr>
<tr>
<td><strong>GID</strong></td>
<td>Group ID attribute to apply to a file or directory. The UID and GID values must be set together as a pair or they are ignored. The UID and GID numbers are internal values returned by the Get File List activity. Typically, you first use the Get File List activity to return a list of files and their attributes. Then you can move a file from a source host to a target host and set the source file attributes on the target file. This flow is demonstrated in the SFTP File Transfer workflow. Field available on following command:</td>
</tr>
<tr>
<td></td>
<td>• Set file attributes</td>
</tr>
</tbody>
</table>
### Permissions

File or directory permissions to set for the user and group specified. This value must be expressed as an integer, such as 16877, which defines these permissions: `rwxr-xr-x`. The permissions numbers are internal values returned by the Get File List activity. Typically, you first use the Get File List activity to return a list of files and their attributes. Then you can move a file from a source host to a target host and set the source file attributes on the target file. This flow is demonstrated in the SFTP File Transfer workflow. Field available on following command:

- Set file attributes

### Access timestamp

Override the timestamp when the file or directory was last accessed. The access and modification timestamps must be set together as a pair. Field available on following command:

- Set file attributes

### Modification timestamp

Override the timestamp when the file or directory was last modified. The access and modification timestamps must be set together as a pair. Field available on following command:

- Set file attributes

### Size in bytes

Size of a file, expressed in bytes. Field available on following command:

- Set file attributes

### Required MID Server capabilities

MID Server with the appropriate capabilities for connecting to the source and target servers.

The system uses this logic to determine which files to move from the source host:

- If the Source files field is empty, the system selects all the files in the source directory. Otherwise, it only selects those files whose names match one of the file name patterns given in the field.
- If the Excluded files field is empty, the system excludes nothing. Otherwise, it excludes those files whose names match one of the file name patterns given in the field.
- The exclude rule has a higher preference than the include rule. If a file name matches one of the file name patterns in the Excluded files field, it does not get into the selection regardless of the include rule.
- When the Include subfolders check box is cleared, the system looks only in the source directory for files to include or exclude. Otherwise, it looks in the source directory and any of its subfolders for files to include or exclude.

**Note:** You can map parameter values in a test payload to variables in the Outputs tab automatically. See automap output variables.

- Use auto-mapping to generate outputs and parsing rules (recommended for JDBC)
- If you do not use auto-mapping, you can manually create output variables and create parsing rules
**SFTP template execution parameters**

You use execution parameters to create the input process script in the **Preprocessing** form.

For descriptions of the command fields, see [Configure the SFTP execution command](#).

**Note:** You must use the `executionParam` prefix with all variables in this table.

### SFTP execution parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>command</td>
<td>String</td>
<td>Identifies the function of this activity. The possible commands are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Copy file</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Create directory</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Get file list</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Remove file or directory</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Rename file or directory</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Set file attributes</td>
</tr>
<tr>
<td>Source</td>
<td>source</td>
<td>String</td>
<td>Identifies the source host.</td>
</tr>
<tr>
<td>Source port</td>
<td>source_port</td>
<td>Integer</td>
<td>Identifies the port used to communicate with the source host.</td>
</tr>
<tr>
<td>Source directory</td>
<td>source_directory</td>
<td>String</td>
<td>Path to the source directory of the files to be moved.</td>
</tr>
<tr>
<td>Source files</td>
<td>source_files</td>
<td>String</td>
<td>Names of the files on the source to be moved.</td>
</tr>
<tr>
<td>Excluded files</td>
<td>excluded_files</td>
<td>String</td>
<td>Lists the files excluded from the operation.</td>
</tr>
<tr>
<td>Source file path</td>
<td>source_file_path</td>
<td>String</td>
<td>Path to the source files to be moved.</td>
</tr>
<tr>
<td>Target host</td>
<td>target_host</td>
<td>String</td>
<td>Identifies the target host.</td>
</tr>
<tr>
<td>Target port</td>
<td>target_port</td>
<td>Integer</td>
<td>Identifies the port used to communicate with the target host.</td>
</tr>
<tr>
<td>Target directory</td>
<td>target_directory</td>
<td>String</td>
<td>Full path to the target directory on the target host.</td>
</tr>
<tr>
<td>Name</td>
<td>Variable</td>
<td>Type</td>
<td>Usage</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Target file path</td>
<td>target_file_path</td>
<td>String</td>
<td>Full path to a file or directory on the source host or on the target host. For example, this value is used in the Rename File or Directory activity in the activity pack.</td>
</tr>
<tr>
<td>Temp file postfix</td>
<td>temp_file_postfix</td>
<td>String</td>
<td>Temporary file name extension used by the Copy File activity when moving a file. If this field contains an extension, the source file is copied to a temporary file using target file name + temp_file_postfix, before being renamed to the actual target file. If this field is blank, the source file is copied directly to the target file.</td>
</tr>
<tr>
<td>Is directory</td>
<td>is_directory</td>
<td>Boolean</td>
<td>Indicates whether the given file path is a directory.</td>
</tr>
<tr>
<td>Include subfolders</td>
<td>include_subfolders</td>
<td>Boolean</td>
<td>Indicates whether the system looks into subfolders of the source directory for files to include and exclude.</td>
</tr>
<tr>
<td>File attribute uid</td>
<td>file_attribute_uid</td>
<td>Integer</td>
<td>User ID associated with a file or directory.</td>
</tr>
<tr>
<td>File attribute gid</td>
<td>file_attribute_gid</td>
<td>Integer</td>
<td>Group ID associated with a file or directory.</td>
</tr>
<tr>
<td>File attribute permissions</td>
<td>file_attribute_permissions</td>
<td>Integer</td>
<td>File or directory permissions for the user and group specified.</td>
</tr>
<tr>
<td>File attribute atime</td>
<td>file_attribute_atime</td>
<td>Integer</td>
<td>Access time stamp from the file attributes.</td>
</tr>
<tr>
<td>File attribute mtime</td>
<td>file_attribute_mtime</td>
<td>Integer</td>
<td>Modification time stamp from the file attributes.</td>
</tr>
<tr>
<td>File attribute size</td>
<td>file_attribute_size</td>
<td>Integer</td>
<td>Size of the file, in bytes.</td>
</tr>
<tr>
<td>Source credential tag</td>
<td>source_credential_tag</td>
<td>String</td>
<td>credential alias used to run the command on the source host.</td>
</tr>
<tr>
<td>Target credential tag</td>
<td>target_credential_tag</td>
<td>String</td>
<td>Credential tag used to run the command on the target host.</td>
</tr>
<tr>
<td>Name</td>
<td>Variable</td>
<td>Type</td>
<td>Usage</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------</td>
<td>--------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>MidCapabilities</td>
<td>midCapabilities</td>
<td>String (comma separated)</td>
<td>List of required MID Server capabilities.</td>
</tr>
</tbody>
</table>

**SFTP post-processing parameters and payload parsing**

Use these parameters to create a post-processing script, payload parsing, and tagging.

### SFTP post-processing parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>output</td>
<td>String</td>
<td>Contains output data returned by the query.</td>
</tr>
<tr>
<td>EccSysId</td>
<td>eccSysId</td>
<td>String</td>
<td>Contains the Reference ID associated with the ECC Queue input message.</td>
</tr>
<tr>
<td>ErrorMessage</td>
<td>errorMessage</td>
<td>String</td>
<td>Contains the error messages returned from the query. If no error messages are returned, this value is null.</td>
</tr>
<tr>
<td>Name</td>
<td>Variable</td>
<td>Type</td>
<td>Usage</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Tags   | tags     | Hashmap of tag values returned from the SSH command | Contains the tags used to extract output using the SSH commands. The tag output is delimited by double percentage signs, as in %tagname%% ... %%. Set up the command using the following format:  

```
%%tagname1%%
output1 line 1
output1 line 2
...
%%

%%tagname2%%
output2 line 1
output2 line 2
...
%%
```

The tags returned are JavaScript hashmap objects in which each key is prefixed with tag appended with the tagname.

```
{"__text__": "
",
"tagtagname1": "output1 line1\noutput1 line2\n",
"tagtagname2": "output2 line1\noutput2 line2\n"}
```
Note: You can test the JDBC connection between the MID Server and the target without having to run the activity in a workflow context. For details, see test template outputs.

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.

SFTP execution command
2. Complete the fields shown in the table.

### SFTP command fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>Type of activity to create. The choices are:</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create directory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Get file list</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Remove file or directory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Rename file or directory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Set file attributes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: The fields displayed on the form depend on the command selected.</td>
<td></td>
</tr>
<tr>
<td>Source host</td>
<td>Name or IP address of the server containing the files targeted by the activity.</td>
<td>All</td>
</tr>
<tr>
<td>Source port</td>
<td>Port number to use to communicate with the source server. The default port number is 22.</td>
<td>All</td>
</tr>
<tr>
<td>Source file path</td>
<td>Full path to a file on a source host.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Copy file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Remove file or directory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Set file attributes</td>
<td></td>
</tr>
<tr>
<td>Source directory</td>
<td>Path to the directory where the source files are located.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create directory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Get file list</td>
<td></td>
</tr>
<tr>
<td>Source files</td>
<td>Names of specific source files to include in the management action. Separate the file names in this list with semi-colons. This field supports the use of wild cards. If this field is blank, all files are included. For information about how the values in this field are affected by options in other fields, see the section below the table.</td>
<td>Get file list</td>
</tr>
<tr>
<td>Is a directory</td>
<td>Check box that determines if the specified file path is a directory.</td>
<td>Remove file or directory</td>
</tr>
<tr>
<td>Credential tag for source</td>
<td>Specific credential alias this activity must use to run SFTP commands on the source host.</td>
<td>All</td>
</tr>
</tbody>
</table>
| Credential tag for target | Specific credential tag this activity must use to run SFTP commands on the target host. | Copy file
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excluded files</td>
<td>Names of specific source files to exclude from the management action. The activity acts on all other files found in the source directory or subfolders. Separate the file names in this list with semi-colons. This field supports the use of wild cards. For information about how the values in this field are affected by options in other fields, see the section below the table.</td>
<td>Get file list</td>
</tr>
<tr>
<td>Include subfolders</td>
<td>Check box to manage the files from subfolders in the source directory. For information about how your selection affects other fields in the form, see the section below the table.</td>
<td>Get file list</td>
</tr>
<tr>
<td>Target host</td>
<td>Name or IP address of the server to which the files are being transferred.</td>
<td>Copy file</td>
</tr>
<tr>
<td>Target port</td>
<td>Port number to use to communicate with the target host. The default port number is 22.</td>
<td>Copy file</td>
</tr>
<tr>
<td>Target file path</td>
<td>Full path to a file on a target host.</td>
<td>• Copy file</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Rename file or directory</td>
</tr>
<tr>
<td>Suffix for temporary file</td>
<td>Temporary suffix to use for a file name if the file already exists on a target host. If this field contains a value, the activity deletes the duplicate target file if it exists, and then copies the source file to a temporary file using <code>targetFilePath + tempFileSuffix</code> as the name. Upon completion, the activity renames the file to the actual target file name. If this field is blank, the activity copies the source file directly to the target file and overwrites it, if it already exists.</td>
<td>Copy file</td>
</tr>
<tr>
<td>UID</td>
<td>User ID attribute to apply to a file or directory. The UID and GID values must be set together as a pair or they are ignored.</td>
<td>Set file attributes</td>
</tr>
<tr>
<td>GID</td>
<td>Group ID attribute to apply to a file or directory. The UID and GID values must be set together as a pair or they are ignored.</td>
<td>Set file attributes</td>
</tr>
</tbody>
</table>
### Field | Description | Command
--- | --- | ---
Permissions | File or directory permissions to set for the user and group specified. This value must be expressed as an integer, such as **16877**, which defines these permissions: `rwxr-xr-x`. The permissions number is an internal value returned by the Get File List activity. Typically, you first use the Get File List activity to return a list of files and their attributes. Then you can move a file from a source host to a target host and set the source file attributes on the target file. This is demonstrated in the SFTP File Transfer workflow. | Set file attributes
Access timestamp | Override the timestamp when the file or directory was last accessed. The access and modification timestamps must be set together as a pair. | Set file attributes
Modification timestamp | Override the timestamp when the file or directory was last modified. The access and modification timestamps must be set together as a pair. | Set file attributes
Size in bytes | Size of a file, expressed in bytes. | Set file attributes
Required MID Server capabilities | MID Server with the appropriate capabilities for connecting to the source and target servers. By default, the system selects an SSH MID Server. | All

The system uses this logic to determine which files to move from the source host:

- If the **Source files** field is empty, the system select all the files in the source directory. Otherwise, it only selects those files whose names match one of the file name patterns given in the field.
- If the **Excluded files** field is empty, the system excludes nothing. Otherwise, it excludes those files whose names match one of the file name patterns given in the field.
- The exclude rule has a higher preference than the include rule. A file whose name matches one of the file name patterns in the **Excluded files** field does not get into the selection, even though it would be selected by the include rule.
- When the **Include subfolders** check box is cleared, the system looks only in the source directory for files to include or exclude. Otherwise, it looks in the source directory and any of its subfolders for files to include or exclude.

3. Click **Save**.
4. Click **Continue** to advance to the **Outputs** stage.

**Create a probe activity**

Create an activity that runs a probe on the target host that is configured to return specific information.
Role required: activity_creator or workflow_admin

For instructions on using the activity template process flow, see create custom activities.

1. Create a custom activity.
   This action creates a custom activity using a template.

2. After setting up general properties and creating input variables, configure the Probe Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map the input variables</td>
<td>Use the variables you created to configure the command that Orchestration executes.</td>
</tr>
<tr>
<td>Probe</td>
<td>Probe to run with this activity, from the list of probes in the system</td>
</tr>
<tr>
<td>Target host</td>
<td>Host name or IP address of the target server for this activity.</td>
</tr>
<tr>
<td>Parameters</td>
<td>MID Server to use, by capabilities.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>Name-value pairs to pass to the host with this probe. You can create these parameters manually, or drag and drop input variables into the parameter fields and assign a value.</td>
</tr>
</tbody>
</table>

**Note:** You can map parameter values in a test payload to variables in the Outputs tab automatically. See automap output variables.

- Use auto-mapping to generate outputs and parsing rules
- If you do not use auto-mapping, you can manually create output variables and create parsing rules

**Probe template execution parameters**
You use execution parameters to create the input process script in the Pre Processing form.

For descriptions of the command fields, see Configure the Probe execution command.

**Note:** You must use the `executionParam` prefix with all variables in this table.

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Probe</td>
<td>probe</td>
<td>Reference</td>
<td>The sys_id of the MID Server probe.</td>
</tr>
<tr>
<td>Source</td>
<td>source</td>
<td>String</td>
<td>Intended target host</td>
</tr>
<tr>
<td>Name</td>
<td>Variable</td>
<td>Type</td>
<td>Usage</td>
</tr>
<tr>
<td>--------------</td>
<td>------------</td>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Parameters   | parameters | Array of JS object    | Array of JavaScript objects, expressed with the executionParam. prefix. To add more name-value pairs to the parameters array, append them to the existing array. Create a JavaScript object with the following syntax, and add it to the executionParam.parameter array. This assigns additional parameters to the message: 
`var newParameter = { "name":"parameterName","value":"parameterValue"};
executionParam.parameters.push(newParameter);` |
| MidCapabilities | midCapabilities | String (comma separated) | List of required MID server capabilities.                                                                                                                                                           |
| ValueCapabilities | valueCapabilities | Array of hashmap | Capability values used to select the MID Server. For more information, see MID Server capabilities. If there are additional capabilities that are assigned by value, use this example to customize the MID Server selection: 
`var valueCapability = {'NEW_MID_CAPABILITY': 'NEW_MID_CAPABILITY_VALUE'};
executionParam.valueCapabilities.push(valueCapability);` |

**Probe template post-processing parameters**

Use these parameters to create a post-processing script.

**Probe post-processing parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payload</td>
<td>payload</td>
<td>String</td>
<td>Contains raw payload returned from the probe.</td>
</tr>
<tr>
<td>Output</td>
<td>output</td>
<td>String</td>
<td>Contains output data returned from the probe.</td>
</tr>
</tbody>
</table>
Configure the Probe execution command
Use the input variables you created to configure the command that Orchestration executes on the target.

Create the input variables you need in the Inputs form before you can advance to the Execution Command stage.

Role required: activity_creator, admin
**Note:** You can test the activity connection between the MID Server and the target without having to run the activity in a workflow context. For details, see test template outputs.

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.
Probe execution command
2. Complete the fields shown in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input variable builder. <a href="#">Create input variables</a> to map to available fields.</td>
</tr>
<tr>
<td>Probe</td>
<td>Probe to run with this activity, from the list of probes in the system.</td>
</tr>
<tr>
<td>Target host</td>
<td>Host name or IP address of the target server for this activity.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server to use, by capabilities.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Name-value pairs to pass to the host with this probe. You can create these parameters manually, or drag and drop input variables into the parameter fields and assign a value.</td>
</tr>
</tbody>
</table>

3. Click **Save**.
4. Click **Continue** to advance to the Outputs stage.

**Create an SSH activity**

Create an activity that extracts data from a target host that uses the SSH network protocol.

Role required: activity_creator or workflow_admin

For instructions on using the activity template process flow, see [create custom activities](#).

1. Create a custom activity.
   - This action creates a custom activity using a template.
2. After setting up general properties and creating input variables, configure the SSH Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map the input variables</td>
<td>Use the variables you created to configure the command that Orchestration executes.</td>
</tr>
<tr>
<td>Target host</td>
<td>Host name or IP address of the target server for this activity.</td>
</tr>
<tr>
<td>Command</td>
<td>Command this activity runs on the target host. You can invoke a MID Server script from this field using any script type that the SSH command line supports. For more information, see <a href="#">Advanced SSH script options</a> below the table.</td>
</tr>
<tr>
<td>Directory</td>
<td>Directory on the target host where the command is run.</td>
</tr>
<tr>
<td>Credential tag</td>
<td>The Orchestration credential tag to use when running the command.</td>
</tr>
<tr>
<td>Required MID Server capabilities</td>
<td>MID Server with the appropriate capabilities for connecting to the host. By default, the system selects a MID Server with SSH capabilities.</td>
</tr>
<tr>
<td>Long running</td>
<td>If checked, disables the SSH connection timeout for commands that might take longer to run than the default 60 seconds. Orchestration periodically checks the running process to determine its status until it is finished.</td>
</tr>
</tbody>
</table>
### ServiceNow Platform capabilities

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must Sudo</td>
<td>If checked, enables the use of <code>sudo</code> to run commands.</td>
</tr>
</tbody>
</table>

**Note:** You can map parameter values in a test payload to variables in the Outputs tab automatically. See automap output variables.

### Advanced SSH script options

To run a MID Server script on the target host, specify the script type and pass the name of the script into the `${syncFile()}` parameter. The system uses this parameter to locate the named script in the MID Server Script File [ecc_agent_script_file] table and run it on the target host. For example, a bash script can be expressed as:

```bash
bash ${syncFile("<MID script name>")} argument1 argument2 argument3
```

A base script (main_script.bash) can reference another script (my_include.bash) as well as a separate file (.my_profile) located on the target host. Both scripts and the file referenced must be synced to the MID Server, using the `${syncFile()}` parameter, to execute properly.

```bash
source ${syncFile(".my_profile")}
cp ${syncFile("my_include.bash")} /usr/ssmith/my_include.bash
bash ${syncFile("main_script.bash")} one two three four five six
rm /usr/ssmith/my_include.bash
```

A Python example with inline comments might look like this:

```bash
set $LIB_DIR=/usr/bin;
# Sync a file that is referenced inside myF5CreateLBPool.py
cp ${syncFile("specialFunctions.py")} ~/specialFunctions.py
# set up environment variables
source ${syncFile(".python_profile")}
# call script that sets up dependencies on the box from remote package repos
python ${syncFile("setUpPythonDependencies.py")} pycontrol
# call a script that requires functions from the package as well as a function from myIncludedFile
python ${syncFile("myF5CreateLBPool.py")} snow_pool myActualValue
# user is responsible for their own cleanup
rm ~/specialFunctions.py
```

- **Use auto-mapping to generate outputs and parsing rules**
- **If you do not use auto-mapping, you can manually create output variables and create parsing rules**

### SSH template execution parameters

Use execution parameters to create the input process script in the [Pre Processing](#) form of the activity designer.

For descriptions of the command fields, see Configure the SSH execution command.

**Note:** You must use the `executionParam.` prefix with all variables in this table.
### SSH execution parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>source</td>
<td>String</td>
<td>Intended target or host.</td>
</tr>
<tr>
<td>Command</td>
<td>command</td>
<td>String</td>
<td>Comment to run on the host.</td>
</tr>
<tr>
<td>Directory</td>
<td>directory</td>
<td>String</td>
<td>Directory on the host in which to run the command.</td>
</tr>
<tr>
<td>Credential tag</td>
<td>credential_tag</td>
<td>String</td>
<td>Orchestration credential tag to use when running the command.</td>
</tr>
<tr>
<td>MidCapabilities</td>
<td>midCapabilities</td>
<td>String (comma separated)</td>
<td>List of required MID Server capabilities.</td>
</tr>
<tr>
<td>ValueCapabilities</td>
<td>valueCapabilities</td>
<td>Array of hashmap</td>
<td>Capability values used to select the MID Server. For more information, see MID Server capabilities. If there are additional capabilities that are assigned by value, use this example to customize the MID Server selection:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>var valueCapability = {'NEW_MID_CAPABILITY': 'NEW_MID_CAPABILITY_VALUE'};</code></td>
</tr>
<tr>
<td>Long running</td>
<td>long_running</td>
<td>Boolean</td>
<td>Indicates whether or not the command is long running. A value of true indicates that the command is long running.</td>
</tr>
<tr>
<td>Must sudo</td>
<td>must_sudo</td>
<td>Boolean</td>
<td>Indicates whether or not this activity must use sudo to run root commands. A value of true indicates that <code>sudo sudo</code> must be used.</td>
</tr>
</tbody>
</table>

### SSH post-processing parameters and payload parsing

Use these parameters to create a post-processing script, payload parsing, and tagging.

#### SSH post-processing parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>output</td>
<td>String</td>
<td>Contains the output returned from the SSH command.</td>
</tr>
<tr>
<td>Name</td>
<td>Variable</td>
<td>Type</td>
<td>Usage</td>
</tr>
<tr>
<td>------------</td>
<td>------------</td>
<td>------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EccSysID</td>
<td>eccSysID</td>
<td>String</td>
<td>Contains the reference ID associated with the ECC Queue input message returned by the activity.</td>
</tr>
<tr>
<td>ErrorMessages</td>
<td>errorMessages</td>
<td>String</td>
<td>Contains the error messages retrieved from the SSH command. This value is <strong>null</strong> if there are no error messages.</td>
</tr>
<tr>
<td>Tags</td>
<td>tags</td>
<td>Hashmap of tag values returned from the SSH command</td>
<td>Contains the tags used to extract output using the SSH commands. The tag output is delimited by double percentage signs, as in <code>%%tagname%% ... %%</code>. Set up the command using the following format:</td>
</tr>
</tbody>
</table>
|            |            |            | `%%tagname1%%
output1 line 1
output1 line 2
...
```
```
`%%tagname2%%
output2 line 1
output2 line 2
...
```
```
The tags returned are JavaScript hashmap objects in which each key is prefixed with `tag` appended with the tagname.

```json
{"__text__":"",
"tagtagname1":"output1 line1
output1 line2",
"tagtagname2":"output2 line1
output2 line2"
}
```

---

**Configure the SSH execution command**

Use the input variables you created to configure the command that Orchestration executes on the host target.

Create the input variables you need in the **Inputs** form before you advance to the **Execution Command** stage.

Role required: activity_creator, admin
### Note:
You can test the SSH connection between the MID Server and the target without having to run the activity in a workflow context. For details, see test template outputs.

1. Drag variables from the list of inputs and drop them into command fields. The system formats the variable in the proper syntax for the command.

### SSH execution command
2. Complete the fields shown in the table.

### SSH activity inputs

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input variable builder. <a href="#">Create input variables</a> to map to available fields.</td>
</tr>
<tr>
<td>Target host</td>
<td>Host name or IP address of the target server for this activity.</td>
</tr>
<tr>
<td>Command</td>
<td>Command this activity runs on the target host. You can invoke a MID Server script from this field using any script type that is supported by the SSH command line. For more information, see <a href="#">Advanced SSH script options</a> below the table.</td>
</tr>
<tr>
<td>Directory</td>
<td>Directory on the target host where the command is run.</td>
</tr>
<tr>
<td>Credential tag</td>
<td>The <a href="#">credential alias</a> to use when running the command.</td>
</tr>
<tr>
<td>Select MID Server by capabilities</td>
<td>MID Server with the appropriate capabilities for connecting to the host. By default, the system selects a MID Server with SSH capabilities</td>
</tr>
<tr>
<td>Long running</td>
<td>Check box to disable the SSH connection timeout for commands that might take longer to run than the default 60 seconds. Orchestration periodically checks the running process to determine its status until it is finished.</td>
</tr>
<tr>
<td>Must Sudo</td>
<td>Check box to allow the use of <code>sudo</code> to run commands.</td>
</tr>
</tbody>
</table>

3. Click **Save**.
4. Click **Continue** to advance to the **Outputs** stage.

### Create a run script activity

Create an activity that runs any script.

Role required: activity_creator or workflow_admin

1. **Create a custom activity.**
   - This action creates a custom activity using a template.

2. After setting up **general properties** and **creating input variables**, configure the Run Script Execution Command:
   - Create a script for this activity to execute.

   **Note:** You can map parameter values in a test payload to variables in the **Outputs** tab automatically. See [automap output variables](#).

   - Use **auto-mapping** to generate outputs and parsing rules
   - If you do not use auto-mapping, you can manually [create output variables](#) and [create parsing rules](#)

**Run Script template processing script**

Use the Run Script custom template Script form to enter a script to call and use with other activities.
Run Script processing script

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processing script</td>
<td>Script that the activity runs.</td>
</tr>
<tr>
<td>Variables</td>
<td>Input variables that are available to use as building blocks in the input process script. Click the arrow above the field to open the variables list. Click an item in the tree to add it to your script in the appropriate syntax. The list displays input variables you passed into the activity on the Inputs form. All activity variables added in the Inputs form are read-only and are expressed in the processing script with this syntax: activityInput.variable.</td>
</tr>
</tbody>
</table>

Create a JMS activity

Create a custom JMS activity to retrieve or send messages to external systems using the Java Messaging Service.

Role required: activity_creator or workflow_admin

The JMS activity supports third party JMS providers whose JMS client application is written with a typical Java EE pattern and can support these operations:

• Using JNDI to find a ConnectionFactory object.
• Using JNDI to find one or more destination objects.
• Using the ConnectionFactory to create a JMS connection object.
• Using the JMS connection to create one or more JMS session objects.
• Using a JMS session and the destinations to create the MessageProducer and MessageConsumer objects.
• Starting the JMS connection to enable delivery or consumption of messages.

Note: The JMS activity designer has been tested with the JMS providers ActiveMQ and Tibco EMS. When connecting to a JMS provider, refer to your third party user documentation.

1. Create or verify your JMS credential.
   Your JMS credentials must have permission for the target database and proper configuration for the corresponding JMS connection. Credentials must be set up before you can create a JMS activity.

2. Create or verify your JMS connection.
   Your JMS connection must be configured with valid JMS credentials set up before you can create a JMS activity.

3. Create a custom activity.
   This action creates a custom activity using a template.

4. After setting up general properties and creating input variables, configure the JMS Execution Command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure your credential</td>
<td>Fill in the fields necessary for your database connection.</td>
</tr>
<tr>
<td>Connection Factory</td>
<td>Name of the JMS Connection Factory. You should create or verify your JMS connection. This configuration links the name of the Initial Context Factory with the URL of the JMS provider.</td>
</tr>
</tbody>
</table>
## Option | Description
--- | ---
**Destination Type** | Type of destination used for this message:
- **Queue**: Message is queued for point-to-point communications. 
  - **Note**: The **GET** operation is only supported for the Queue destination type.
- **Topic**: Message is used for publish and subscribe communication.

**Destination Name** | Name of the queue or topic destination that is configured on the JMS provider.

**Message Type** | The JMS message type value. Only the **Text Message** type is supported. The queue or topic destination must be configured to receive or send only Text Message. Other message types are dropped, since the JMS Activity cannot process them.

**Operation** | The programmatic operation to perform on the destination. The choices are **PUT** or **GET**.

**Timeout (Secs)** | Allowed time to wait for a message in the message queue before it times out, in seconds. The default is **30**.

**Custom message headers** | The custom header values in a name/value pair format, that is available on the JMS destination.
  - **Note**: This is only supported for a **PUT** operation.

**Message payload** | Actual message content or payload that is sent to the JMS destination.
  - **Note**: This is only supported for a **PUT** operation.

**Credential tag** | A tag for an individual credential for a JMS activity in an Orchestration workflow.

**Required MID Server capabilities** | MID Server to use, by capabilities.

- Use auto-mapping to generate outputs and parsing rules
- If you do not use auto-mapping, you can manually [create output variables](https://www.servicenow.com/docs/service-now/now-platform/administration/automating-workflows/service-orchestration.html#ORCHESTRATION) and [create parsing rules](https://www.servicenow.com/docs/service-now/now-platform/administration/automating-workflows/service-orchestration.html#ORCHESTRATION)

### Create a JMS connection for an Orchestration activity
Configure your system to use Java Messaging Service (JMS) with a custom Orchestration JMS activity.

**Role required**: admin

The MID Server must have the correct JMS connection factories for your organization. Configure those values in the `mid.property.jms.command.allowed_factory_names` property, found in **MID Server > Properties**. The default values for this property can be changed to any value or comma-separated list of values that the third-party JMS provider advertises.

1. Navigate to **MID Server > JAR Files**.
2. Click **New** and add:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique and descriptive name for identifying the file in the instance.</td>
</tr>
<tr>
<td>Version</td>
<td>A version number for the file, if one is available.</td>
</tr>
<tr>
<td>Source</td>
<td>Location of the JAR file for reference purposes. Source information is not used by the system.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the JAR file and its purpose in the instance.</td>
</tr>
</tbody>
</table>

3. Click the paper clip icon in the banner and attach the JMS driver jar file.

The JMS driver jar file should be available as part of JMS provider installation. Few JMS vendors make them available as a separate product. Refer to the JMS provider documentation to determine which JMS client driver jar files require the client applications to connect to the JMS provider. For example, if you are trying to connect to ActiveMQ V5.10 (JMS provider), you need the `activemq-all-5.10.1.jar` file.

4. Navigate to **Orchestration > Credentials & Connections > JMS Connection Factory**.

5. Click **New**, add the following, and click **Submit**:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of this connection factory.</td>
</tr>
<tr>
<td>Initial Context Factory</td>
<td>Name of the JNDI class that is used to create the InitialContext.</td>
</tr>
</tbody>
</table>

**Note:** For example, to connect to ActiveMQ V5.10 (JMS Provider), the value is `org.apache.activemq.jndi.ActiveMQInitialContextFactory`.

<table>
<thead>
<tr>
<th>Provider URL</th>
<th>Location of the running JMS provider installation.</th>
</tr>
</thead>
</table>

**Note:** For example, to connect to ActiveMQ V5.1:tcp://ipAddressOrHostName:61616.

6. Navigate to **Orchestration > Credentials**.

7. Click **New**, select **JMS Credentials**, and provide the user name and password the MID should use to communicate with the JMS provider.

For more information, see JMS credentials.

8. Click **Submit**.

You are ready to create a custom JMS activity.

**JMS template execution parameters**

You use execution parameters to create the input process script in the **Preprocessing** form.

You must use the `executionParam.` prefix with all variables in this table.

**JDBC execution parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jms ds</td>
<td>jms_ds</td>
<td>Reference</td>
<td>Selected JMS data source.</td>
</tr>
<tr>
<td>Destination type</td>
<td>destination_type</td>
<td>Enumerated</td>
<td></td>
</tr>
</tbody>
</table>
### ServiceNow Platform capabilities

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination name</td>
<td>destination_name</td>
<td>String</td>
<td></td>
</tr>
<tr>
<td>Message type</td>
<td>message_type</td>
<td>Enumerated</td>
<td></td>
</tr>
<tr>
<td>Operation</td>
<td>operation</td>
<td>Enumerated</td>
<td></td>
</tr>
<tr>
<td>Time out</td>
<td>time_out</td>
<td>Integer</td>
<td>Length of time to wait for the query to return results.</td>
</tr>
<tr>
<td>Custom headers</td>
<td>custom_headers</td>
<td>Array of JavaScript objects</td>
<td></td>
</tr>
<tr>
<td>Message payload</td>
<td>message_payload</td>
<td>String</td>
<td></td>
</tr>
<tr>
<td>Credential tag</td>
<td>credential_tag</td>
<td>String</td>
<td>List of required MID Server capabilities.</td>
</tr>
<tr>
<td>MidCapabilities</td>
<td>midCapabilities</td>
<td>String (comma separated)</td>
<td>Capability values used to select the MID Server. For more information, see MID Server capabilities. If there are additional capabilities that are assigned by value, use this example to customize the MID Server selection:</td>
</tr>
<tr>
<td>ValueCapabilities</td>
<td>valueCapabilities</td>
<td>Array of hashmap</td>
<td></td>
</tr>
</tbody>
</table>

**JMS template post-processing parameters**

Use these parameters to create a post-processing script.

**JMS post-processing parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Variable</th>
<th>Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>status</td>
<td>String</td>
<td>Status of the operation (Put or Get) on the JMS destination.</td>
</tr>
<tr>
<td>StandardHeaders</td>
<td>standardHeaders</td>
<td>String</td>
<td>All the standard headers, as specified by JMS, that are obtained as part of the JMS message during a Get operation. This field is applicable only for Get operations.</td>
</tr>
<tr>
<td>Name</td>
<td>Variable</td>
<td>Type</td>
<td>Usage</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
<td>--------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CustomHeaders</td>
<td>customHeaders</td>
<td>String</td>
<td>All custom headers added by a producer or publisher application that are obtained as part of the JMS message during a Get operation. This field is applicable only for Get operations.</td>
</tr>
<tr>
<td>MessagePayload</td>
<td>messagePayload</td>
<td>String</td>
<td>Message payload that is obtained as part of the JMS message during a Get operation. This field is applicable only for Get operations.</td>
</tr>
<tr>
<td>EccSysID</td>
<td>eccSysID</td>
<td>String</td>
<td>Contains the reference ID associated with the ECC Queue input message returned by the activity.</td>
</tr>
<tr>
<td>ErrorMessages</td>
<td>errorMessages</td>
<td>String</td>
<td>Contains any error messages retrieved from the JMS command. This value is null if there are no error messages.</td>
</tr>
</tbody>
</table>

### Activity scoping

Custom activities run in their own scope, even if it is different from that of the workflow.

Any script that runs inside a custom activity with a scope can only access outside artifacts that are within the scope of that activity or artifacts that are configured to run in any scope. Conversely, an outside artifact can only access the script inside that private activity if the outside artifact is running in the same scope. Activities with public scopes can interact with outside artifacts in any application scope.

You can use private activities as part of a workflow that has a public application scope. These activities are protected from reaching outside of the workflow or from being reached from outside the workflow. For details about setting application scoping for custom activities, see the field description table for the appropriate activity template.

**Note:** Custom activities uploaded to the ServiceNow Store must be configured as accessible to all application scopes.

### Publish a custom activity

When a user creates a custom activity and saves or submits it, that activity appears in the Custom and Packs tabs of the designer palette, but is visible only to the user who created it.

Roles required: admin, activity_admin, activity_creator

1. When you finish configuring the activity, click **Publish**.

   This makes the activity accessible to other users on the instance with the workflow_admin or activity_creator role. Published activities are available for upload to the ServiceNow Store, can be added to workflows, and can be edited by any user with the proper roles.
2. To edit a published activity, click **Checkout**.
   When an activity is checked out by a user, only that user can modify it. The fields of a checked out activity are read-only for all other users.
3. When you are finished editing the checked out activity, publish it again.
   The system adds a new version of this activity to the **Custom** tab in the Workflow Editor palette.

**Note:** Activities you create and publish are visible in the **Packs** tab only if they were created in the current application scope.

**Return a locked activity to a published state**

Problems can arise if an activity version is checked out by a user and not checked back in. An activity in this state cannot be checked out for update.

**Role required:** admin, activity_admin, activity_creator

An administrator can return a locked activity to a published state.

1. Open the Workflow Editor.
2. From the **Custom** tab, open the activity that is locked.
3. Click the menu icon in the title bar and select **Versions** from the context menu.
   A list of all the versions of that activity appears. The locked version displays the user who checked it out.

4. Select the checked out version.
   The system opens the record in the activity designer.
5. Click the menu icon again and select **Force Checkout** from the context menu.
   The activity fields become editable.
6. Click **Publish**.
   The activity becomes available to users with the appropriate roles.
Copy a custom activity

You can copy activities for reuse from the Custom tab in the global scope.

Role required: admin, activity_admin, activity_creator

Note: You cannot copy an activity in a private scope.

1. To reuse an activity in the global scope, expand the parent category to display the activities.
2. Right-click the activity you want to copy and select one of these options:
   - **Copy into global scope as new activity**: Copies the activity with the new name you provide, uses the same version number as the original activity, and moves it to the global scope in the Custom tab.

   ![Adding a new activity copy](image)

   Naming an activity copy

   - **Copy into global scope as new version**: Copies the activity using the same name, increments the version number, and moves it to the global scope in the Custom tab. The system automatically adds the parent category to the Custom tab if it does not already exist. This action will overwrite another activity with the same name and version number.

   ![Confirming a new activity version](image)

   Creating a new activity version

Note: If the activity is in any other scope but global, the system displays this message: Cannot copy privately scoped activity.

Orchestration databus

The databus allows workflow designers to track the flow of data through an Orchestration workflow and provides access to output data that can be consumed by other custom activities.

Data is made available in a workflow when you use activities created with the Orchestration activity designer. The activity designer provides the ability to specify well defined inputs and outputs for your
activities. When you use those activities on the workflow canvas, the outputs appear in the Data tab and are available for use as inputs in subsequent activities.

**Note:** Orchestration does not filter the data you are given for reuse in the Data tab. You must make sure an activity in the workflow canvas has executed before you consume its output data.

When you drop a custom activity onto the workflow canvas, the system assigns it an index. If you delete an activity from the canvas and add a new one, the indexes are not reused. This ensures that you don’t accidentally start subscribing to data you did not intend to use. If you update an activity in the activity designer, the system automatically updates the activity on the canvas to ensure the data you are subscribing to downstream is not affected.

**Reuse data in the activity designer**

The Data tab in the Workflow Editor lists all custom activities used in the current workflow that produce data and displays that data for reuse in other custom activities.

Roles required: workflow_creator

Activities are categorized by application in this tab and are available for use as data sources for other activities. The Data tab is a graphical representation of the workflow Databus, which manages all the temporary data used by the current workflow.

1. Drag output variables from an activity in this tab into the inputs of another activity on the workflow canvas to link the activities together.

   You can use any of the outputs in the structure, regardless of the the application to which they belong. An index number in parenthesis after the activity name provides a unique identifier for the parameters that you use as input data in other activities. If you do not name a custom activity, the only identifier for that activity in the Data tab is the index number. Index numbers indicate the sequence in which custom activities were added to the workflow and are not reused. When you drag a custom activity onto the workflow canvas, the system adds that activity and its output data to the structure.
Conversely, if you remove a custom activity from the canvas, that activity and its outputs disappear from the data list.
2. Point to an activity to display information about it in a pop-up window. Any output data reused by the activity is listed in the **Databus Output** field of the pop-up window.

![Pop-up window showing Databus Output](image)

### MID Servers for Orchestration

Orchestration automatically selects an appropriate MID Server based on the capabilities that you configure in activities, the IP addresses of target devices, and the application that the MID Server is allowed to use.

To allow a MID Server to work with Orchestration, it must have the **Orchestration** application or the **ALL** application assigned to it. See [Configure a default MID Server for each application](#) for instructions.

You can have MID Servers focus on different capabilities and separate sections of your network. See:

- MID Server capabilities
- Map an IP address to a DNS name

You can also specify a default MID Server to use if no MID Servers meet the capability and IP range criteria for an activity. See [Select the default MID Server for Orchestration](#).

### MID Server capabilities

MID Server capabilities define the specific functions of a MID Server within an IP address range.

### Nmap capability

The **Nmap** capability is only assigned to MID Servers for which the Network Mapper (Nmap) scanner has been installed for **credential-less Discovery**. This capability cannot be added to or removed from any MID Server manually. For instructions on installing or uninstalling Nmap, see [Install and uninstall Nmap on a MID Server](#).

---

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
MID Server capability values

Capabilities provided in the base system do not have a defined value string. A MID Server configured to use a capability that has no value can locate any device using that capability’s protocol. If a capability has a defined value, the MID Server using that capability finds only those devices using that protocol that match the value string exactly. The exception to this is the Resolve DNS capability, which is configured to resolve any DNS name into an IP address using a partial string match.

Starting with the madrid release, the [capability name]:[value] combination appears in the slushbucket when you add a capability to a MID Server. This combination allows you to see all the capabilities that have different values, even if the capability name is the same. For example, if you are using the Cloud Management capability, and you use the value field to specify the us-west logical datacenter on one of the capability records, you can see the combination in the Collection list.

Scripted MID Server capability value matching

You can use value tests to create capabilities that find devices using values without requiring exact string matching. Action on these values is controlled by a user-defined script.
The Resolve DNS capability is provided in the base system and is configured to resolve DNS names into IP addresses for devices whose names end with a specified domain name. The capability Value entered is automatically prefaced with a dot during processing to match domain syntax. This value can contain one or more sub-domains, but must include the end of the domain string. Matching devices must end with the identical syntax. The script for the Resolve DNS capability determines if a device name matches the criteria defined by Value. If a match exists, the platform performs the address resolution automatically. For example, if the value for the Resolve DNS capability is service-now.com, the MID Server with this capability finds lnxlab01.sandiego.service-now.com and dbsrv101.sanjose.service-now.com. If the value is changed to sandiego.service-now.com, then the MID Server finds only lnxlab01.

Note: If Value in the Resolve DNS capability is blank, then all domains match.

To view the script for evaluating this capability, navigate to MID Server > Capability Value Tests and select Resolve DNS from the list.
Configure MID Server capabilities

MID Server capabilities define the specific functions of a MID Server within an IP address range, allowing an application to select the most appropriate MID Server. Configure capabilities on MID Servers for applications like Orchestration, Cloud Management, and Service Mapping.

Role required: admin or sm_admin
Several applications use capabilities, IP ranges, and MID Server selection to narrow the pool of MID Servers the applications need.

Note: At least one capability is required for each MID Server used by Orchestration. See MID Servers for Orchestration for more information.

The following capabilities are available by default with Discovery:

<table>
<thead>
<tr>
<th>All</th>
<th>IBM</th>
<th>Resolve DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ansible</td>
<td>JDBC</td>
<td>REST</td>
</tr>
<tr>
<td>AWS</td>
<td>NetApp</td>
<td>SNMP</td>
</tr>
<tr>
<td>Azure</td>
<td>Nmap</td>
<td>SOAP</td>
</tr>
<tr>
<td>Chef</td>
<td>OpenStack</td>
<td>SSH</td>
</tr>
<tr>
<td>Cloud Management</td>
<td>PowerShell</td>
<td>VMware</td>
</tr>
<tr>
<td>Google</td>
<td>RCA</td>
<td>WMI</td>
</tr>
</tbody>
</table>

1. Navigate to MID Server > Capabilities.
2. Select an existing capability. You can also select ALL to include all capabilities.

Note: Ensure that each IP address range has MID Servers with the necessary capabilities to complete the Orchestration activities on that network segment.

3. Create a new capability:
   a) Click New.
   b) Configure the value for a custom capability. An example is a capability for DOMAIN, with a value of service-now.
   c) Click Submit.
4. Click Edit in the MID Servers related list to add MID Servers to the capability.
5. Select one or more MID Servers for this capability from the Available list.
6. Click Save.

The capability defined here also appears in the primary record for this MID Server.

**Select the default MID Server for Orchestration**

Orchestration uses the default MID Server if it cannot find a MID Server with the correct IP range and capability.

Specify the default MID Server in either of these locations:

- The Default MID Server field on the Orchestration application record. See Configure a default MID Server for each application for instructions.
- The Default MID Server to use for Orchestration Activities property. Navigate to Orchestration > MID Server Properties to set this value.

These two values are automatically kept in synch. You can change the default MID Server in either location.

**PowerShell probe version 2 system property**

View detailed PowerShell credential information and view extended logging information.

Starting with the madrid release, there is a new system property for the PowerShell probe which enables the version 2 of the probe. This new version enables you to view detailed credential information on why PowerShell credentials fail or succeed. You can also view logging information for an ECC Queue payload and Workflow Context log.

`mid.server.rba_powershell_v2`

Enables the PowerShell probe version 2 for use with all PowerShell activities. The default value is true. If you choose false, the legacy PowerShell probe is used. Unless there are issues, use version 2, as the legacy version is going to be deprecated.

**Note:** This property only applies to Orchestration activities. Discovery probes are not affected.

You can access the property by selecting the MID Server Properties link in the navigation pane:

**PowerShell log property**

Enable debug messages to display from PowerShell.
This property enables control of when and where to display debug messages generated by debug statements embedded in the PowerShell scripts.

**mid.property.powershell.log_info**

The new MID Server PowerShell log property:

- Displays logging information.

---

**Note:** Once logging is enabled, OOB PowerShell scripts log information.

- Adds logging information to your developed PowerShell scripts and PowerShell activities.

---

**Note:** Logging information is only available when property is enabled.

- Logging is not enabled by default.

If the property is set to true, debug messages display from the workflow context or from the Response popup after you test inputs. The ecc_queue entry payload for each of the PowerShell activities is going to show all the debug messages that were logged.

Enable the PowerShell log property for each MID Server. If the MID Server field is empty, the property applies to all MID Servers. There are separate credential debug messages that always come back regardless of this setting. The credential debug messages show which credentials have been used and other related information.

---

**Note:** All the debug messages that come back to the instance are also saved to the MID Server log file. The log file might have additional debug messages generated from Java code, which might help the debug process.

---

### Use the Orchestration Usage dashboard

This dashboard shows an overview of Orchestration usage metrics to show customers how their organization uses Orchestration and to support license compliance.
Role required: orchestration_manager

1. To view the dashboard, navigate to **Orchestration > Operations & Troubleshooting > Orchestration Usage Dashboard**.

The Orchestration Usage dashboard displays. The tabs on the dashboard include Licensable Usage and Orchestration Usage. Reports on these tabs include:

**Orchestration Usage Metrics**

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
</table>
| Transaction Summary Last 12 months                           | A running transaction count of all Orchestration transactions over the last 12 months. Includes:  
  - The count of orchestration transactions associated with the HR Application  
  - The count of Orchestration transactions associated with the Security Operations Application |
| Transaction Summary YTD                                      | Cumulative count of all transactions since the time the Orchestration plugin was activated or the customer upgraded to Geneva.                                                                                |
| 365 day Running Average of Server                            | The running average over the last 365 days for cmdb_ci_computer - cmdb_ci_server. This includes all physical and virtual client nodes and excludes server nodes from the count.                                       |
| 365 day Running Average of Client                            | The running average over the last 365 days for cmdb_ci_server. This includes all physical and virtual server nodes.                                                                                           |
| Orchestration Transactions by Month for Last 12 Months       |                                                                                                                                                                                                            |
| Average Client Nodes Orchestrated Last 365 Days             |                                                                                                                                                                                                            |
| Average Server Nodes Orchestrated Last 365 Days             |                                                                                                                                                                                                            |
| Number of Orchestration Activities Developed Last 365 Days  | The aggregate number of activity definitions you have developed and OOB activity definitions you have modified. This number includes activity elements (Activities build with the Activity Designer) you have developed and OOB activity definitions you have modified. |
| Note: his number excludes activity elements that are shipped with ServiceNow Applications that use the Orchestration Runtime e.g. ServiceNow Security Operations and Human Resources Apps. |
| Cumulative Client Nodes Orchestrated by Month               |                                                                                                                                                                                                            |
| Cumulative Server Nodes Orchestrated by Month               |                                                                                                                                                                                                            |
| Usage by Provider Last 12 Months                             | Breaks down emphasis by provider, such as PowerShell, JDBC, SSH, etc.                                                                                                                                       |
2. Optional: You can add more widgets to the dashboard by clicking the Add Content icon ( ) in the upper right corner of the dashboard.

**Note:** You should not modify the first tab in this Dashboard. If you want a different dashboard experience, add a tab and customize that with your usage reports.

## Password Reset application

The ServiceNow® Password Reset application enables an end user to use a self-service process to reset or change the password. Alternatively, your organization can implement a process that requires a service desk agent to reset passwords for end users.

### Explore
- Password Reset release notes#unique_2383
- Upgrade to New York

### Set up
- Password Reset setup guide
- Password Reset Windows Application

### Administer
- Password Reset admin guide
- Plan your Password Reset processes
- Configure your Password Reset process
- Password Reset and Password Change reports and logs

### Use
- Service desk: Reset a password or unlock a user account
- Unblock a Password Reset user
- Users: Reset your password on Windows systems

### Develop
- Developer training
- Developer documentation

### Integrate
- Integrate Password Reset with a CMS integration

### Troubleshoot and get help
- Ask or answer questions in the Change Management forum
- Search the HI Knowledge Base for known error articles
- Contact ServiceNow Technical Support

## Password Reset setup guide

A simple version of the Password Reset application is active by default. You can install a plugin to extend functionality.

### Requirements

Role required: admin
Active and available plugins

- A simple version of the Password Reset application is active by default and includes example verifications. The base system enables connections only to the Local ServiceNow Instance credential store type. For details, see Credential stores for Password Reset.
- To enable connections to Active Directory (AD) and Remote (SOAP) ServiceNow Instance credential store types, you must activate the Password Reset - Orchestration Add-on plugin. The plugin also activates the Password Reset Windows Application (com.glideapp.password_reset_desktop). No other components are installed. Orchestration is available as a separate subscription. See Request the Password Reset - Orchestration Add-on plugin.

Next steps

Plan and configure the Password Reset processes for your organization. See the Password Reset admin guide.

Request the Password Reset - Orchestration Add-on plugin

The Password Reset - Orchestration Add-on plugin activates the Password Reset Windows Application (com.glideapp.password_reset_desktop) and enables connections to the Active Directory (AD) and 'Remote (SOAP) ServiceNow instance' credential store types. No other components are installed.

Role required: admin

There are two ways to request a plugin:

- Access the HI Service Catalog directly by clicking Service Catalog > Activate Plugin on HI.
- Access the HI Service Catalog through the All Applications page on your instance by following these steps.

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click **Request Plugin** to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.

![Activate Plugin]

In order to enhance the user experience, we have redesigned Activate a Plugin service catalog. Please use the new HI Service Portal 'Activate a Plugin' service catalog item. You can also use Manage Instances page on Service Portal to Activate a Plugin.

Take me to the HI Service Portal Activate a Plugin Service Catalog.

4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>this plugin to be enabled</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are</td>
</tr>
<tr>
<td></td>
<td>activating the plugin. For example, if you need the plugin activated at</td>
</tr>
<tr>
<td></td>
<td>a specific time instead of during one of the default activation windows,</td>
</tr>
<tr>
<td></td>
<td>specify it in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Installed with Password Reset**

Tables, roles, business rules, scripts, and workflows are installed with the Password Reset application.

**Password Reset tables**

<table>
<thead>
<tr>
<th>Table name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset Active Answer [pwd_active_answer]</td>
<td>Security questions and associated answers, in an encrypted state, that users selected while going through the enrollment process.</td>
</tr>
<tr>
<td>Table name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password Reset Active Question [pwd_active_question]</td>
<td>Security questions that users selected while going through the enrollment process.</td>
</tr>
<tr>
<td>Password Reset Activity Monitor [pwd_activity_monitor]</td>
<td>Password Reset lockout activity.</td>
</tr>
<tr>
<td>Password Reset Credential Store [pwd_cred_store]</td>
<td>Password Reset credential stores that are available.</td>
</tr>
<tr>
<td>Password Reset Credential Store Parameters [pwd_cred_store_param]</td>
<td>User-created credential store parameters.</td>
</tr>
<tr>
<td>Password Reset Credential Store Types [pwd_cred_store_type]</td>
<td>Password Reset credential store types that are available.</td>
</tr>
<tr>
<td>Password Reset Desktop Access Control [pwd_access_control]</td>
<td>Password Reset Windows Application access control.</td>
</tr>
<tr>
<td>Password Reset Desktop Access Log [pwd_access_log]</td>
<td>Password Reset Windows Application access logs.</td>
</tr>
<tr>
<td>Password Reset Device Enrollment Code [pwd_dvc_enrollment_code]</td>
<td>Device enrollment codes that were sent to users during SMS code enrollment.</td>
</tr>
<tr>
<td>Password Reset Devices [pwd_device]</td>
<td>User SMS devices that are in a state of verified.</td>
</tr>
<tr>
<td>Password Reset Email Verification Code [pwd_email_code]</td>
<td>Verification codes that were sent to users via email for password reset or email address enrollment.</td>
</tr>
<tr>
<td>Password Reset Enrollment for Verification [pwd_enrollment]</td>
<td>Information about user enrollment by verification.</td>
</tr>
<tr>
<td>Password Reset Enrollment Snapshot [pwd_enrollment_snapshot]</td>
<td>Snapshot of user enrollment by verification. This table is regenerated daily by a scheduled job named Password Reset Enrollment Snapshot.</td>
</tr>
<tr>
<td>Password Reset Extension Type [pwd_extension_type]</td>
<td>Extension types that are available.</td>
</tr>
<tr>
<td>Password Reset History [pwd_history]</td>
<td>History of passwords that users reset.</td>
</tr>
<tr>
<td>Password Reset Identification Type [pwd_identification_type]</td>
<td>Password Reset identification types that are available.</td>
</tr>
<tr>
<td>Table name</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Password Reset Process [pwd_process]</td>
<td>Password Reset processes that are available.</td>
</tr>
<tr>
<td>Password Reset Process Credential Store [pwd_map_proc_to_cred_store]</td>
<td>Credential stores and the associated Password Reset processes that the application is using.</td>
</tr>
<tr>
<td>Password Reset Process User Group [pwd_map_proc_to_group]</td>
<td>Groups and the associated Password Reset processes that the application is using.</td>
</tr>
<tr>
<td>Password Reset Process Verification [pwd_map_proc_to_verification]</td>
<td>Verifications and the associated Password Reset processes that the application is using.</td>
</tr>
<tr>
<td>Password Reset Question [pwd_question]</td>
<td>Questions that the application uses for security question verifications.</td>
</tr>
<tr>
<td>Password Reset Request [pwd_reset_request]</td>
<td>Information about Password Reset requests.</td>
</tr>
<tr>
<td>Password Reset Request Verification [pwd_map_request_to_verification]</td>
<td>Password reset requests and the associated verification that the application is using.</td>
</tr>
<tr>
<td>Password Reset SMS Verification Code [pwd_sms_code]</td>
<td>SMS verification codes that were sent to users for a password reset.</td>
</tr>
<tr>
<td>Password Reset User Lockout [pwd_user_lockout]</td>
<td>Users that are locked out of Password Reset.</td>
</tr>
<tr>
<td>Password Reset Verification [pwd_verification]</td>
<td>Verifications that are available.</td>
</tr>
<tr>
<td>Password Reset Verification Param [pwd_verification_param]</td>
<td>User-created verification parameters.</td>
</tr>
<tr>
<td>Password Reset Verification Type [pwd_verification_type]</td>
<td>Password Reset verification types that are available.</td>
</tr>
</tbody>
</table>

### Password Reset roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>password reset administrator [password_reset_admin]</td>
<td>Configures and maintains Password Reset and Password Change.</td>
</tr>
<tr>
<td>service desk agent [password_reset_service_desk]</td>
<td>Resets passwords on behalf of users, tracks password reset requests, and views logs.</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>credentials manager</td>
<td>Determines which credential stores are valid for use with Password Reset.</td>
</tr>
</tbody>
</table>

### Password Reset business rules

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort if password history limit exceeds</td>
<td>Password Reset Credential Store Parameters [pwd_cred_store_param]</td>
<td>Prevents setting password history limit that exceeds the value of the password_reset.history.limit property.</td>
</tr>
<tr>
<td>Add default parameters QA verification</td>
<td>Password Reset Verification [pwd_verification]</td>
<td>If no parameters for Security Question verifications are specified, generates parameters.</td>
</tr>
<tr>
<td>Add default parameters SMS verification</td>
<td>Password Reset Verification [pwd_verification]</td>
<td>If there are no parameters specified, generates SMS code verifications parameters.</td>
</tr>
<tr>
<td>Add params personal confirm verification</td>
<td>Password Reset Verification [pwd_verification]</td>
<td>If there are no parameters specified, generates personal data confirmation verifications parameters.</td>
</tr>
<tr>
<td>Add params personal verification</td>
<td>Password Reset Verification [pwd_verification]</td>
<td>If there are no parameters specified, generates parameters for personal data verification.</td>
</tr>
<tr>
<td>Check unique verifications</td>
<td>Password Reset Process Verification [pwd_map_proc_to_verification]</td>
<td>Prevents a verification from being assigned multiple times to a specific Password Reset process.</td>
</tr>
<tr>
<td>Clear parameters for Mock verification</td>
<td>Password Reset Verification [pwd_verification]</td>
<td>Clears parameters for the Mock verification.</td>
</tr>
<tr>
<td>Deactivate process with no group</td>
<td>Password Reset Process User Group [pwd_map_proc_to_group]</td>
<td>Deactivates the process if it does not apply to all users or if the groups associated with it are removed.</td>
</tr>
<tr>
<td>Deactivate process with no min ver</td>
<td>Password Reset Process Verification [pwd_map_proc_to_verification]</td>
<td>Deactivates the process if the verifications associated with the process are less than the minimum value for the process.</td>
</tr>
<tr>
<td>Deactivate process with no verification</td>
<td>Password Reset Process Verification [pwd_map_proc_to_verification]</td>
<td>Deactivates the process if the verifications associated with it are removed.</td>
</tr>
<tr>
<td>Delete history passwords if needed</td>
<td>Password Reset Credential Store [pwd_cred_store]</td>
<td>Deletes history passwords if needed.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Enforce password history message</td>
<td>Password Reset Credential Store [pwd_cred_store]</td>
<td>Passes enforce password history related messages to the client side.</td>
</tr>
<tr>
<td>Google Auth Enabled Check</td>
<td>Password Reset Process [pwd_process]</td>
<td>Deactivates the process with Google Authenticator verification if the Google authenticator is disabled.</td>
</tr>
<tr>
<td>GoogleAuthSysPropertyCheck</td>
<td>Password Reset Process Verification [pwd_map_proc_to_verification]</td>
<td>Deactivates the process with the Google Authenticator verification if the Google authenticator is disabled.</td>
</tr>
<tr>
<td>Handle req_enroll validation/default val</td>
<td>Password Reset Process Verification [pwd_map_proc_to_verification]</td>
<td>Handles requires_enrollment and auto_enroll values for the process.</td>
</tr>
<tr>
<td>Insert/update scheduled job for reminder</td>
<td>Password Reset Process [pwd_process]</td>
<td>Inserts/updates the scheduled job for enrollment reminder.</td>
</tr>
<tr>
<td>Order must be unique</td>
<td>Password Reset Desktop Access Control [pwd_access_control]</td>
<td>Enforces order to be unique.</td>
</tr>
<tr>
<td>Parameter Names Cannot Be Updated</td>
<td>Password Reset Verification Param [pwd_verification_param]</td>
<td>Prevents parameter name changes.</td>
</tr>
<tr>
<td>Password Reset Activity Monitor</td>
<td>Password Reset User Lockout [pwd_user_lockout]</td>
<td>Creates an event when the number of users locked out of Password Reset during a specific interval exceeds the threshold value.</td>
</tr>
<tr>
<td>Password Reset Validate Auto-generate</td>
<td>Password Reset Process [pwd_process]</td>
<td>Checks that either Email password or Display password is selected when the Auto-generate password check box is selected.</td>
</tr>
<tr>
<td>Personal Data Confirm Param Validation</td>
<td>Password Reset Verification Param [pwd_verification_param]</td>
<td>Checks that a column exists in the sys_user table for the parameter used in a personal data confirmation verification.</td>
</tr>
<tr>
<td>Personal Data Param Validation</td>
<td>Password Reset Verification Param [pwd_verification_param]</td>
<td>Checks that a column exists in the sys_user table for the parameter used in a personal data verification.</td>
</tr>
<tr>
<td>Prevent against deletion</td>
<td>Password Reset Credential Store [pwd_cred_store]</td>
<td>Checks whether the credential store is part of an active process before allowing deletion.</td>
</tr>
<tr>
<td>Prevent against deletion</td>
<td>Password Reset Identification Type [pwd_identification_type]</td>
<td>If an identification type is part of an active process, prevents the identification type from being deleted.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Prevent against deletion</td>
<td>Password Reset Verification</td>
<td>If the verification is part of an active process, prevents it from being deleted.</td>
</tr>
<tr>
<td></td>
<td>[pwd_verification]</td>
<td></td>
</tr>
<tr>
<td>Prevent against deletion when in use</td>
<td>Password Reset Credential Store Types</td>
<td>Prevents deletion when the type is in use.</td>
</tr>
<tr>
<td></td>
<td>[pwd_cred_store_type]</td>
<td></td>
</tr>
<tr>
<td>Prevent against deletion when in use</td>
<td>Password Reset Verification Type</td>
<td>Prevents deletion when the type is in use.</td>
</tr>
<tr>
<td></td>
<td>[pwd_verification_type]</td>
<td></td>
</tr>
<tr>
<td>Queue event if history limit decreases</td>
<td>Password Reset Credential Store Parameters</td>
<td>Queues the pwd.credStore.history.limit.decrease event if history limit decreases.</td>
</tr>
<tr>
<td></td>
<td>[pwd_cred_store_param]</td>
<td></td>
</tr>
<tr>
<td>Security Questions Param Validation</td>
<td>Password Reset Verification Param</td>
<td>Checks for valid parameters in security question verifications.</td>
</tr>
<tr>
<td></td>
<td>[pwd_verification_param]</td>
<td></td>
</tr>
<tr>
<td>Send SMS code</td>
<td>Password Reset Device Enrollment Code</td>
<td>Sends an enrollment code to a device.</td>
</tr>
<tr>
<td></td>
<td>[pwd_dvc_enrollment_code]</td>
<td></td>
</tr>
<tr>
<td>Set new record flag</td>
<td>Password Reset Process</td>
<td>Sets a new record flag for the client to take appropriate action.</td>
</tr>
<tr>
<td></td>
<td>[pwd_process]</td>
<td></td>
</tr>
<tr>
<td>Send SMS Verification Code Via Notify</td>
<td>Password Reset SMS Verification Code</td>
<td>Sends out SMS authentication code via Notify if the Notify plugin is active.</td>
</tr>
<tr>
<td></td>
<td>[pwd_sms_code]</td>
<td></td>
</tr>
<tr>
<td>Single credential store per process</td>
<td>Password Reset Process Credential Store</td>
<td>Prevents having more than one credential store per process.</td>
</tr>
<tr>
<td></td>
<td>[pwd_map_proc_to_cred_store]</td>
<td></td>
</tr>
<tr>
<td>SMS Code Param Validation</td>
<td>Password Reset Verification Param</td>
<td>Checks for valid parameters in SMS code verifications.</td>
</tr>
<tr>
<td></td>
<td>[pwd_verification_param]</td>
<td></td>
</tr>
<tr>
<td>Update action based on access conditions</td>
<td>Password Reset Desktop Access Log</td>
<td>Updates the “action” field of this log record based on the access control conditions.</td>
</tr>
<tr>
<td></td>
<td>[pwd_access_log]</td>
<td></td>
</tr>
<tr>
<td>Update proc_to_cred_store</td>
<td>Password Reset Process</td>
<td>Enforces a one-to-one relation between a Password Reset process and a credential store.</td>
</tr>
<tr>
<td></td>
<td>[pwd_process]</td>
<td></td>
</tr>
<tr>
<td>Validate Process</td>
<td>Password Reset Process</td>
<td>Verifies that a Password Reset process is configured correctly.</td>
</tr>
<tr>
<td></td>
<td>[pwd_process]</td>
<td></td>
</tr>
<tr>
<td>Validate Pwd Cred Store Name</td>
<td>Password Reset Credential Store</td>
<td>Enforces the name to be unique.</td>
</tr>
<tr>
<td></td>
<td>[pwd_cred_store]</td>
<td></td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Validate Pwd Cred Store Type Name</td>
<td>Password Reset Credential Store Types [pwd_cred_store_type]</td>
<td>Enforces the name to be unique.</td>
</tr>
<tr>
<td>Validate Pwd Extension Type Name</td>
<td>Password Reset Extension Type [pwd_extension_type]</td>
<td>Enforces the name to be unique.</td>
</tr>
<tr>
<td>Validate Pwd Identification Type Name</td>
<td>Password Reset Identification Type [pwd_identification_type]</td>
<td>Enforces the name to be unique and not empty.</td>
</tr>
<tr>
<td>Validate Pwd Process Name</td>
<td>Password Reset Process [pwd_process]</td>
<td>Enforces the name to be unique.</td>
</tr>
<tr>
<td>Validate Pwd Verification Name</td>
<td>Password Reset Verification [pwd_verification]</td>
<td>Enforces the name to be unique.</td>
</tr>
<tr>
<td>Validate Pwd Verification Type Name</td>
<td>Password Reset Verification Type [pwd_verification_type]</td>
<td>Enforces the name to be unique.</td>
</tr>
<tr>
<td>Validate Security Question</td>
<td>Password Reset Question [pwd_question]</td>
<td>Validates rules for security questions such as no duplicates or empty questions.</td>
</tr>
<tr>
<td>Verify Account Lookup Script</td>
<td>Password Reset Credential Store [pwd_cred_store]</td>
<td>Checks whether the account lookup script has the correctly named function.</td>
</tr>
<tr>
<td>VerifyAutoEnroll</td>
<td>Password Reset Verification Type [pwd_verification_type]</td>
<td>Checks whether auto-enroll is selected and ensures that an enrollment check script is provided.</td>
</tr>
</tbody>
</table>

### Password Reset UI pages

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$pwd_reset</td>
<td>First page of self-service reset process (asks for user ID).</td>
</tr>
<tr>
<td>$pwd_reset_serviceDesk</td>
<td>First page of service desk assisted reset process (asks for user ID).</td>
</tr>
<tr>
<td>$pwd_verify</td>
<td>Second page of reset process (asks user to verify identity).</td>
</tr>
<tr>
<td>$pwd_new</td>
<td>Last page of password change process (asks for new password).</td>
</tr>
<tr>
<td>$pwd_success</td>
<td>Page that appears when password is reset successfully.</td>
</tr>
<tr>
<td>$pwd_error</td>
<td>Page that appears on error during reset process.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>$pwd_confirm</td>
<td>For processes configured to email password reset URL: After successful verification, this page displays message about sending link to user.</td>
</tr>
<tr>
<td>$pwd_change</td>
<td>Page for changing password.</td>
</tr>
<tr>
<td>$pwd_change_success</td>
<td>Page that appears when password is changed successfully.</td>
</tr>
<tr>
<td>$pwd_change_error</td>
<td>Page that appears on error during password change process.</td>
</tr>
<tr>
<td>$pwd_enrollment_form_container</td>
<td>Enrollment page for all verifications.</td>
</tr>
<tr>
<td>$pwd_enrollment_success</td>
<td>Page that appears when enrollment is successful.</td>
</tr>
<tr>
<td>$pwd_enroll_error</td>
<td>Page that appears when any error happens during enrollment.</td>
</tr>
<tr>
<td>$pwd_unlock_success</td>
<td>Page that appears when locked user is successfully unlocked.</td>
</tr>
<tr>
<td>$pwd_reset_downloads_ui</td>
<td>Page for downloading Password Reset Windows Application.</td>
</tr>
</tbody>
</table>

### Password Reset UI macros

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$pwd.csrf_validation</td>
<td>CSRF validation for Password Reset Application. If violation is detected, the page will be redirected to the error page.</td>
</tr>
<tr>
<td>$pwd.display_password</td>
<td>Displays a temporary password on the success page if the process is configured to auto-generate.</td>
</tr>
<tr>
<td>$pwd.enroll_email_ui and $pwd.verify_email_ui</td>
<td>UI for email enrollment and verification.</td>
</tr>
<tr>
<td>$pwd.enroll_google_auth_ui and $pwd.verify_google_auth_ui</td>
<td>UI for Google Authentication enrollment and verification.</td>
</tr>
<tr>
<td>$pwd.enroll_questions_ui</td>
<td>UI for question and answer security validation enrollment.</td>
</tr>
<tr>
<td>$pwd.enroll_questions_ui.js</td>
<td>JavaScript code that requires server-side data for security question and answer enrollment.</td>
</tr>
<tr>
<td>$pwd.enroll_sample_ui</td>
<td>Sample UI macro for enrollment for Mock Verification Type.</td>
</tr>
<tr>
<td>$pwd.enroll_sms_ui and $pwd.verify_sms_ui</td>
<td>UI for SMS enrollment and verification.</td>
</tr>
<tr>
<td>$pwd.enrollment_form_title</td>
<td>Jelly macro function that prints the title for the enrollment form. A verification ID is mandatory.</td>
</tr>
<tr>
<td>$pwd.error_message</td>
<td>UI for displaying error messages.</td>
</tr>
<tr>
<td>$pwd.process_flow</td>
<td>UI for indicating current stage.</td>
</tr>
<tr>
<td>$pwd.process_footer</td>
<td>JavaScript code to get the footer macro name.</td>
</tr>
</tbody>
</table>
UI scripts installed with Password Reset

You can create a UI script and reference the script from a UI macro or UI page by using a `<g:include_script>` Jelly tag. The following example shows how the $pwd_enroll_questions_ui UI macro can reference the $pwd_enroll_questions_ui script. In the example, [UI Script Name]+".jsdbx" is the name of the script:

```xml
<g:include_script src="$pwd_enroll_questions_ui.jsdbx" />
```

By referencing an external script, you can maintain separation between client JavaScript code and Jelly code, which simplifies maintenance. You can use the following installed scripts with Password Reset UI macros:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$pwd_csrf_common_ui_script</td>
<td>Common UI script for handling a Cross-site Request Forgery (CSRF).</td>
</tr>
<tr>
<td>$pwd_enroll_email_ui</td>
<td>JavaScript code for the $pwd_enroll_questions_ui UI macro.</td>
</tr>
<tr>
<td>$pwd_enroll_google_auth_ui</td>
<td>JavaScript code for the $pwd_enroll_google_auth_ui UI macro.</td>
</tr>
<tr>
<td>$pwd_enroll_questions_ui</td>
<td>JavaScript code for the $pwd_enroll_questions_ui UI macro.</td>
</tr>
<tr>
<td>$pwd_enroll_sample_ui</td>
<td>Included sample client JavaScript for the $pwd_enroll_sample_ui UI macro.</td>
</tr>
<tr>
<td>$pwd_enroll_sms_ui</td>
<td>SMS enrollment UI script.</td>
</tr>
<tr>
<td>$pwd_enrollment_submit_event</td>
<td>UI script for an enrollment submission event.</td>
</tr>
<tr>
<td>$pwd_util</td>
<td>Utilities for password reset UI pages and UI macros.</td>
</tr>
<tr>
<td>$pwdWfManager</td>
<td>Helper class to handle workflow activities and post-processing.</td>
</tr>
</tbody>
</table>

Password Reset workflows

The Password Reset plugin adds workflows that you can use as examples to create custom workflows for Password Reset processes.
### Workflows that connect to a credential stores

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Reset - AD</td>
<td>Connects to an AD server.</td>
</tr>
<tr>
<td>Pwd Reset - Local ServiceNow</td>
<td>Current (local) instance.</td>
</tr>
<tr>
<td>Pwd Reset - Master</td>
<td>Password Reset master workflow.</td>
</tr>
<tr>
<td>Pwd Reset - Mock Fatal</td>
<td>Example workflow to use in Password Reset testing to simulate a fatal error. No retries.</td>
</tr>
<tr>
<td>Pwd Reset - Mock Non Fatal</td>
<td>Example workflow to use in Password Reset testing to simulate a non-fatal error.</td>
</tr>
<tr>
<td>Pwd Reset - Mock Success</td>
<td>Example workflow to use in Password Reset testing to simulate a successful completion.</td>
</tr>
<tr>
<td>Pwd Reset - Remote ServiceNow</td>
<td>Connects to a remote(SOAP) ServiceNow instance.</td>
</tr>
</tbody>
</table>

### Workflows that test the connection to a credential store

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Connection Test - AD</td>
<td>Tests connection to an AD server.</td>
</tr>
<tr>
<td>Pwd Connection Test - Local SN</td>
<td>Tests connection to local instance.</td>
</tr>
<tr>
<td>Pwd Connection Test - Master</td>
<td>Master workflow to test credential store connectivity.</td>
</tr>
<tr>
<td>Pwd Connection Test - Mock Failure</td>
<td>Example credential store connection test that simulates a failed connection.</td>
</tr>
<tr>
<td>Pwd Connection Test - Mock Success</td>
<td>Example credential store connection test that simulates a successful connection.</td>
</tr>
<tr>
<td>Pwd Connection Test - Remote SN</td>
<td>Tests connection to a remote(SOAP) ServiceNow instance.</td>
</tr>
</tbody>
</table>

### Workflows that determine the lock state of a user account

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Get Lock State - AD</td>
<td>Gets a user account lock state for the AD server.</td>
</tr>
<tr>
<td>Pwd Get Lock State - Local SN</td>
<td>Workflow to get a user account lock state for the local instance.</td>
</tr>
<tr>
<td>Pwd Get Lock State - Master</td>
<td>Master workflow to get a user account lock state.</td>
</tr>
<tr>
<td>Pwd Get Lock State - Remote SN</td>
<td>Gets a user account lock state for the remote(SOAP) ServiceNow instance.</td>
</tr>
</tbody>
</table>

### Workflows that unlock a user account

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Unlock Account – AD</td>
<td>Unlocks a user account for a local instance.</td>
</tr>
</tbody>
</table>
### Workflows that change a password

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Unlock Account - Local SN</td>
<td>Workflow to unlock a user account for a local instance.</td>
</tr>
<tr>
<td>Pwd Unlock Account - Master</td>
<td>Master workflow to unlock a user account.</td>
</tr>
<tr>
<td>Pwd Unlock Account – Remote SN</td>
<td>Unlocks a user account for a remote(SOAP) ServiceNow instance.</td>
</tr>
</tbody>
</table>

### Password Reset notifications

<table>
<thead>
<tr>
<th>Name</th>
<th>Fired by event name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset – Send SMS Code</td>
<td>pwd.send_sms_code.trigger</td>
<td>Sends out SMS authentication code for verification.</td>
</tr>
<tr>
<td>[K] Password Reset – Send Email Code</td>
<td>pwd.send_email_code.trigger</td>
<td>Sends out authentication code via Email for verification.</td>
</tr>
<tr>
<td>Password Reset - Enrollment Reminder</td>
<td>pwd.enrollment_reminder.trigger</td>
<td>Sends emails to remind users to enroll in the required verifications.</td>
</tr>
<tr>
<td>Password Reset - New Password Confirmation</td>
<td>pwd.email.trigger</td>
<td>For the Email Password process, sends an email that includes the new password.</td>
</tr>
<tr>
<td>Password Reset - Send Verify Code</td>
<td>pwd.send_verify_code.trigger</td>
<td>Sends authentication code to users using email or SMS for password reset or enrollment.</td>
</tr>
</tbody>
</table>

---

**Note:** If the Notify plugin is active, SMS code is sent via Twilio instead of ServiceNow Notification.
### Password Reset URL

<table>
<thead>
<tr>
<th>Name</th>
<th>Fired by event name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset URL</td>
<td>password.reset.url</td>
<td>For the Email Password Reset URL process: Sends email that includes a link to the password reset URL.</td>
</tr>
</tbody>
</table>

**Note:** Check the following items if the instance does not send the email notification to the user:

- Check the System Event [sys_event] table to see if the email was sent.
- Verify that the user is subscribed to the notification.
- Verify that the Default Self Service password reset process and password reset properties are configured correctly.

### SOAP messages for Password Reset

<table>
<thead>
<tr>
<th>SOAP Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Password</td>
<td>When the Orchestration Add-on plugin is active, the system can use the SOAP protocol to change passwords on remote credential stores such as a remote ServiceNow instance.</td>
</tr>
<tr>
<td>Password Reset Request</td>
<td>When the Orchestration Add-on plugin is active, the system can use the SOAP protocol to reset passwords on remote credential stores such as a remote ServiceNow instance.</td>
</tr>
</tbody>
</table>

### REST API

Name: Pwd Reset  
API ID: pwd_reset  
Base API path: /api/now/pwd_reset
## Resources (Version v1)

<table>
<thead>
<tr>
<th>Name</th>
<th>Resource path</th>
<th>API Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pwd_init</td>
<td>/api/now/v1/pwd_reset/init</td>
<td>v1</td>
<td>Initial request to establish session, write logs, and fetch UI messages.</td>
</tr>
<tr>
<td>pwd_identify</td>
<td>/api/now/v1/pwd_reset/identify</td>
<td>v1</td>
<td>Get identification page components.</td>
</tr>
<tr>
<td>pwd_verify</td>
<td>/api/now/v1/pwd_reset/verify</td>
<td>v1</td>
<td>Get verification page components.</td>
</tr>
<tr>
<td>pwd_new</td>
<td>/api/now/v1/pwd_reset/reset</td>
<td>v1</td>
<td>Get resetting password page components.</td>
</tr>
<tr>
<td>pwd_success</td>
<td>/api/now/v1/pwd_reset/success</td>
<td>v1</td>
<td>Get success page components.</td>
</tr>
<tr>
<td>pwd_failure</td>
<td>/api/now/v1/pwd_reset/failure</td>
<td>v1</td>
<td>Get failure page components.</td>
</tr>
</tbody>
</table>

## Resources (Version v2)

<table>
<thead>
<tr>
<th>Name</th>
<th>Resource path</th>
<th>API Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pwd_init</td>
<td>/api/now/v2/pwd_reset/init</td>
<td>v2</td>
<td>Initial request to establish session, write logs, and fetch UI messages.</td>
</tr>
<tr>
<td>pwd_identify</td>
<td>/api/now/v2/pwd_reset/identify</td>
<td>v2</td>
<td>Get identification page components.</td>
</tr>
<tr>
<td>pwd_verify</td>
<td>/api/now/v2/pwd_reset/verify</td>
<td>v2</td>
<td>Get verification page components.</td>
</tr>
<tr>
<td>pwd_new</td>
<td>/api/now/v2/pwd_reset/reset</td>
<td>v2</td>
<td>Get reset password page components.</td>
</tr>
<tr>
<td>pwd_success</td>
<td>/api/now/v2/pwd_reset/success</td>
<td>v2</td>
<td>Get success page components.</td>
</tr>
<tr>
<td>pwd_failure</td>
<td>/api/now/v2/pwd_reset/failure</td>
<td>v2</td>
<td>Get failure page components.</td>
</tr>
</tbody>
</table>

## Domain separation in the Password Reset application

A password reset process that you define in any domain is isolated from a process that you create in any other domain. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

## Overview

**Support: Level 2**
Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

Each password reset process follows these steps:
1. The end user asks to reset the password.
2. The user provides identifying information (typically username or email address).
3. The user verifies the identity — proves that they are who they say they are (typically by answering questions or submitting a code number that was delivered securely).
4. The instance connects to the credential store to confirm the user credentials.
5. The instance generates the new password and displays it to the user.

How domain separation works in Password Reset

Domain separation for Password Reset is applied at the process level. The admin configures the following elements to define a password reset process: A connection to a credential store, user groups that can use the process, method of identification, and verifications to use during the process.

- A connection to the credential store where user credentials (like username/password) are securely stored. Each connection inherits the domain setting from a template called a connection type. Each connection type is tied to a domain (the connection type record has a domain field). There are uniqueness constraints on connection names within a domain.
- One or more user groups on the ServiceNow instance that can use the password reset process. User accounts are members of one or more domains — they use the standard ServiceNow domain separation. When a user enrolls to use one of the password reset processes that is configured for the organization, the user is allowed to choose only from the processes in the user’s domain.
- The identification — the method that the end user employs to claim identity for the public password reset or password change process. Each identification inherits the domain setting from a template called an identification type. Each identification type is tied to a domain (the identification type record has a domain field). There are uniqueness constraints on identification names within a domain.
- One or more verifications — methods to verify the identity of the person who is attempting to reset the password. Each verification inherits the domain setting from a template called a verification type. Each verification type is tied to a domain (the verification type record has a domain field). There are uniqueness constraints on verification names within a domain.
- All Password Reset tables have a domain column.
- Password Reset process tables include a sys-overrides column on business rules, UI actions, and so on.
- The Password Reset application is built using Orchestration. Orchestration supports "Data only" domain separation — the data security model of separating visibility of data from one domain to another.

Self-service and Service desk-assisted processes

In addition to configuring the connections, user groups, identifications, and verifications that are used in each process, the admin specifies one of the following operational methods for the organization:

- Self-service process: End users reset passwords over the Internet using a browser on any supported interface, including mobile devices. The end user can select from any configured process in the end user’s domain (or child domain of an end user’s domain).
- Service desk-assisted process: End users do not reset passwords. An end user requests the assistance of a service desk agent, over the phone or in person. The agent processes the request. Each service desk agent has the Password Reset Admin service desk role. The “reset request” form that the agent
works in presents a **User** field and a **Process** field. On the form, the agent can view all processes in the end user’s domain, even if the agent is not a member of one or more of the domains.

**Password Change process**

The Password Change application extends the Password Reset application by letting admins define how users change their passwords. A service desk-assisted process is not supported. An admin must publish the URL for the self-service password change form.

The Password Change application enables an end user to change a password over the Internet using a browser on any supported interface, including mobile devices. The end user can select from any configured process in the end user’s domain (or child domain of an end user’s domain).

A password change process uses the same elements as a password reset process (connections, user groups, identifications, and verifications), with the same domain-separation features.

**Password Reset Windows Application**

The Password Reset Windows Application enables a user, who forgets the password or is locked out of a Windows computer, to reset the password directly from the Windows login screen.

**Installer and documentation**

Download the installer and installation instructions from [KB0542328](KB0542328) in the ServiceNow Knowledge Base. The installer uninstalls any earlier version of the Password Reset Windows Application.

**How the Password Reset Windows Application works**

Administrators download and run an EXE or MSI file to install or distribute the application to user computers. The application installs a link on the Windows login screen. The user clicks the link (**Forgot Password?** as depicted in the examples on various Windows versions) and is then guided through the process of resetting the password.
By default, when a user requests a reset, the instance sends the user a URL with a user-specific token. After the user opens the URL, the instance prompts the user to enter and confirm the new password. The instance does not send a temporary password.

**Restrictions on the Password Reset Windows Application**

- The Password Reset Windows Application does not support custom verifications.
- The Password Reset Windows Application uses the base-system CAPTCHA service even if the Password Reset application is configured to use Google reCAPTCHA with the web interface. See the section titled "Settings on the Details tab of the Password Reset Processes form" in [https://docs.servicenow.com](https://docs.servicenow.com).
- The Password strength indicator is not supported. See the topic titled "Configure your Password Reset process" in [https://docs.servicenow.com](https://docs.servicenow.com).
- For some verification types, you can use only one verification. Custom verifications are not supported. See the topic titled "Password Reset verifications" in [https://docs.servicenow.com](https://docs.servicenow.com).
- Custom UI macros configured on the **Process > Advanced** page are not supported (for example, entry, success, or failure macros). The system displays only the default success and failure messages.
- The Password Reset Windows Application supports newline characters in the **Password rule hint** text. Other formatting is not supported (bold, underline, hyperlink, and so on). See the topic titled "Configure the connection to a credential store for the Password Reset processes" in [https://docs.servicenow.com](https://docs.servicenow.com).

**Password Reset Windows Application installation requirements**

Activate the Password Reset Orchestration Add-on plugin to use the Password Reset Windows Application.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required ServiceNow</td>
<td>Password Reset Windows Application version 4.0 is supported on Kingston,</td>
</tr>
<tr>
<td>release</td>
<td>London, and Madrid releases. Jakarta and earlier releases are not supported.</td>
</tr>
</tbody>
</table>
### Password Reset Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Required hardware</strong></td>
<td></td>
</tr>
<tr>
<td>• 1 GHz or faster processor</td>
<td></td>
</tr>
<tr>
<td>• 512 MB of RAM</td>
<td></td>
</tr>
<tr>
<td>• 10 MB of available hard disk space (x86)</td>
<td></td>
</tr>
<tr>
<td>• 10 MB of available hard disk space (x64)</td>
<td></td>
</tr>
<tr>
<td><strong>Required software</strong></td>
<td></td>
</tr>
<tr>
<td>Version of Password Reset Windows Application</td>
<td>Microsoft .NET Framework</td>
</tr>
<tr>
<td>4.0</td>
<td>4.7.1 and newer</td>
</tr>
<tr>
<td><strong>Supported operating systems</strong></td>
<td></td>
</tr>
<tr>
<td>• Windows 7</td>
<td></td>
</tr>
<tr>
<td>• Windows 8.1</td>
<td></td>
</tr>
<tr>
<td>• Windows 10 Enterprise</td>
<td></td>
</tr>
<tr>
<td>• Windows 10 Pro</td>
<td></td>
</tr>
<tr>
<td><strong>Supported processor architecture</strong></td>
<td></td>
</tr>
<tr>
<td>• X86</td>
<td></td>
</tr>
<tr>
<td>• X64</td>
<td></td>
</tr>
<tr>
<td><strong>Supported network architecture</strong></td>
<td></td>
</tr>
<tr>
<td>• Password Reset Windows Application clients must have direct access to both the Internet and the ServiceNow instance where the Password Reset Windows Application is configured</td>
<td></td>
</tr>
<tr>
<td>• For Password Reset Windows Application versions that use an SHA certificate, the corporate network must not block the SHA certificate.</td>
<td></td>
</tr>
<tr>
<td>• To reset an AD password, the client must be on the corporate network.</td>
<td></td>
</tr>
</tbody>
</table>

### Password Reset admin guide

The Password Reset application enables an end user to reset or change a password using a self-service process. Alternatively, your organization can implement a process that requires a service desk agent to reset passwords for end users.

Watch the video: Introducing Password Reset (video)

### Password Reset processes

Users with the `password_reset_admin` role configure how the process of resetting a password works for an end user.

- **Self-service process**: Users reset passwords over the Internet using a browser on any supported interface, including mobile devices.
- **Service desk-assisted process**: A user requests the assistance of a service desk agent, over the phone or in person. Users do not reset passwords.
End-user experience of the self-service process

The following example is typical:

1. On the login page, the user clicks the **Forgot Password?** link to start the process.
2. The Identify page opens and the user enters their identifying information (typically username or email address). The example includes the default Google reCAPTCHA security feature:

![Identify page](image)

3. On the Verify page, the user verifies their identity by providing information that proves that they are who they say they are. You, the admin, configure the method of verification and you can require multiple verifications. In the example, the admin has configured the Security Question verification. The user must answer a question to prove identity. (Earlier, the user selected the question and provided a secure private answer while enrolling for the password reset process.) Other possible verifications require the user to enter a code number that was sent to a mobile device by SMS text, through the Google Authenticator app, or by email.

![Verify page](image)
4. The system checks the credential store to verify identity and then displays the new password on the Reset page.

Elements of a password reset process

You configure the following elements of the process for your organization:

- A connection to the credential store for your organization where user credentials (like username/password) are securely stored.
- One or more user groups on the ServiceNow instance that can use the password reset process.
- The type of identification that users must enter to identify themselves (typically username or email address).
• One or more verifications — methods to verify the identity of the user. Examples:
  • Answer a question that only the user knows how to answer — the QA Verification (based on the Security Question verification type).
  • Enter a code number that was emailed to the user — the Email verification.
  • Enter a code number that was texted to a mobile device — the SMS verification.
  • Enter a code number that appears on the Google Authenticator app on a mobile device — the Google Authenticator verification.

How you implement a password reset process

1. Plan your implementation: Ensure that all applicable organizational guidelines, security policies, and areas of the organization are considered.
2. Set up the elements of the password reset and password change processes according to the plan:
   • Connection to the credential store.
   • User groups that will use the password reset process.
   • Identification type to use.
   • Verifications to use.
3. In the service desk-assisted model, assign service desk agents to monitor and reset passwords as needed.
4. Monitor password reset activity to identify security threats and to ensure compliance with the password policy requirements of your organization.

Password Reset Windows Application

If a user forgets the password or gets locked out of a Windows computer, the user can reset the password directly from the Windows login screen. The user clicks the Forgot Password? link and is then guided through the process of resetting the password. To learn more, see Password Reset Windows Application.

Password Change application

The Password Change application extends the Password Reset application by letting admins define how users change their passwords. Only a self-service process is supported and an admin must publish the URL to the password change form.

1. The user logs in to the instance and then selects the Change Password module or link from the user profile record. Password change is supported on mobile devices.
2. On the Change Password page, the user selects the credential store where the password resides.
3. The user enters the old password and then enters and confirms a new password.
4. Workflows validate the old password and then implement the new password.
5. The system notifies the user that the password was changed.

What to do next

Plan your Password Reset processes
Example: The default self-service Password Reset process

The default self-service Password Reset process enables a user to reset the password without assistance from service desk agents.

The default self-service password reset flow

1. If a user does not remember the password, the user can click the **Forgot Password?** link on the login screen.

2. The Password Reset application starts. On the **Identity** page, the user identifies himself or herself by entering a **Username**.

3. On the **Verify** page, the user proves that they are the person who is associated with the username. In this example, the user enters the email address that is associated with the user profile. The admin can configure a different verification method or can require additional verifications, for example, a personal question that only the user can answer.
4. The **Reset** page tells the user to check email for instructions.

![Reset page](image)

5. The user opens the email and clicks the **here** link to reset the password. The link is valid for a period that you specify (use the `password_reset.request.expiry` property).

   ![Preview email](image)

   Hello
   
   A password reset was requested for your user account on the ServiceNow instance [https://demonightlyplatformsecurity.service-now.com/](https://demonightlyplatformsecurity.service-now.com/).
   
   Click [here](https://demonightlyplatformsecurity.service-now.com) to reset your password. If you do not want to reset your password, please disregard this email.
   
   The link will expire in 12 hours.
   
   If you did not request this password reset, please notify your company's ServiceNow administrator.

6. The **Reset Password** page guides the user to reset the password.

![Reset Password page](image)

The default self-service Password Reset process (`com.glideapp.password_reset`) defines:

- The URI that specifies where users are redirected when they click **Forgot Password**. By default this value is `/pwd_reset.do?sysparm_url=ss_default`, which is the same value used in the `glide.security.password_reset.uri` property. In previous releases, this value was set to `/reset_password.do`.

- The **Enable Password Reset URL** option, which specifies that the user should receive an email with a link to reset their password after they click **Forgot Password**.

- The **Personal Data - Enter Email Address** verification flow that specifies the three-step password reset flow.

See for instructions on accessing this form and configuring the fields.
Plan your Password Reset processes

To ensure security and efficiency, take the time to plan your Password Reset implementation.

Role required: password_reset_admin or admin

1. Decide on the password reset process:
   • **Self-service process**: Users reset their password over the Internet using a browser on any supported interface, including mobile devices. To make the Password Reset application with Orchestration available to all users publicly, create a new Password Reset process only for this purpose and make it accessible to all users by setting the **Public access** property. See Example: The default self-service Password Reset process.
   • **Service desk-assisted process**: Users reset passwords by requesting the assistance of a service desk agent, over the phone or in person. Only service desk agents with the password_reset_service_desk role can reset user passwords. Watch the videos: Resetting User Passwords (Video) and How to Set Up a Service Desk-Assisted Password Reset Process (Video).

2. Decide how groups and roles differ in access and security needs.
   Analyze and assess how members of each group in your organization access the system. For example, if members of the sales group primarily access the system remotely, consider using a stronger method or multiple methods to verify the identity of each user.

   Identify user roles that have access to critical information and resources. For example, stronger verifications might be required for roles that have access to employee data, accounting information, or network configurations.

   Based on your analysis of groups and roles, determine the number and variety of verifications needed for the different Password Reset processes.

3. Decide how to manage credentials.
   Determine whether single sign-on is enabled with the type of directory service or other credential store used. If the directory service is configured for single sign-on, consider increasing the level of security by using multiple methods to verify identity of a user. A compromised user name and password can easily allow access to associated systems in a single sign-on environment.

4. Decide how to implement enrollment in the Password Reset program.
   For example, will enrollment be optional or required? Will users be auto-enrolled? How will users be notified to enroll in the program? The answers to these questions will help you determine the appropriate verification types to use.

5. Decide which Password Reset options to offer to users.
   • If your organization uses single sign-on, how will users reset their password if they are unable to log on?
   • What options are available to users working off-site?
Configure your Password Reset process

To implement the process, you configure credentials, verification methods and settings, and enrollment settings. You also specify which users the process applies to.

Role required: password_reset_admin or admin

1. Be sure to Plan your Password Reset processes.
2. Create the credential store record for usernames and passwords that are managed.
   
   **Note:** For LDAP integrations: If the Active Directory settings require users to reset the password when logging in, the results depend on the Password Reset plugin that is installed.
   
   - The Password Reset plugin cannot change an AD password. End users will not be able to log in to the instance.
   - The Self Service Password Reset plugin depends on the Password Reset Basic plugin. Self service is intended for password reset only on the local ServiceNow instance and cannot change an AD password.
   - The Password Reset Orchestration Add-on plugin is built on top of Orchestration AD activities. The plugin supports changing the AD password.

3. Define the verifications that the process will use.
4. Configure Password Reset to auto-enroll users or to enable users to enroll for the program. See Configure your Password Reset process to auto-enroll users and Enable users to enroll for Password Reset.

A Password Reset process consists of the following elements:

- The credential store that contains user login credentials.
- Optionally, the user groups that are authorized to use the Password Reset process.
- The verifications that verify the identity of the requesting user and that enable the service desk agents to authorize reset of the password. (Verifications are implemented by script includes.)

1. Navigate to Password Reset > Processes.
2. Click New and then specify a meaningful Name and Description for the process.
3. Select the Credential store that contains the user credentials that the process applies to.
4. Specify the process that you are defining: Select the Password Reset check box, the Password change check box or both check boxes.
5. Specify the Apply to all users setting.

<table>
<thead>
<tr>
<th>Setting of the Apply to all users check box</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected</td>
<td>All users use the process that you are defining. This setting is useful only if all users have access to the authentication methods that are defined in this process.</td>
</tr>
<tr>
<td>Not selected</td>
<td>Only the users in the groups that you specify use the process. You specify the groups in the Groups related list.</td>
</tr>
</tbody>
</table>
6. For **Password Reset**, configure settings on the **Password Reset Details** tab.

**Settings on the Details tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public access</td>
<td>The check box is available only when <strong>Password reset</strong> is selected.</td>
</tr>
<tr>
<td></td>
<td>• Select the check box to enable a self-service process with public user access to the Password Reset or Password Change form through a URL.</td>
</tr>
<tr>
<td></td>
<td>• Clear the check box to define a Service desk-assisted process in which only service desk agents can reset a password at the request of a user.</td>
</tr>
<tr>
<td>Public URL</td>
<td>The field is available only when <strong>Public access</strong> is selected. URL of the page where users go to reset or change the password. The value from the URL suffix field is appended to the URL when you tab out of the URL suffix field. For the Default self-service Password Reset process, this value must be <code>/$pwd_reset.do?sysparm_url=ss_default</code>.</td>
</tr>
<tr>
<td>URL suffix</td>
<td>The field is available only when <strong>Public access</strong> is selected. Suffix used to create a unique URL for the Password Reset or Password Change form.</td>
</tr>
<tr>
<td>Display CAPTCHA</td>
<td>The check box is available only when <strong>Public access</strong> is selected. Select the check box to display a CAPTCHA on the user identification page.</td>
</tr>
<tr>
<td></td>
<td>The Password Reset application uses Google reCAPTCHA as the default CAPTCHA service. See <a href="#">Configure Google reCAPTCHA for the password reset process</a>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Password Reset Windows Application uses the base-system CAPTCHA service even if the Password Reset application is configured to use Google reCAPTCHA.</td>
</tr>
<tr>
<td></td>
<td>Because on-premises instances do not have access to the Internet, the instances cannot use the Google reCAPTCHA service. Set the <code>password_reset.captcha.google.enabled</code> system property to <code>false</code> for on-premises instances.</td>
</tr>
<tr>
<td></td>
<td>To use the base system CAPTCHA, change the <code>password_reset.captcha.google.enabled</code> system property to <code>false</code>.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Identification type</td>
<td>Method that the user employs to claim identity for the public Password Reset or Password Change process. Any selection overrides the default identification that is associated with the process. The base system includes the Email and Username Identification identification types. You can create a custom identification type (some knowledge of JavaScript is recommended). See Personal data identification types and confirmation type verifications.</td>
</tr>
<tr>
<td>Post-reset URL</td>
<td>URL to go to after a successfully resetting a password — typically, the URL of the original login page. Enter a complete path, including the protocol (for example, <a href="https://myDomain.myURL.com">https://myDomain.myURL.com</a>). If the path is under the same domain as the Public URL, then start the path with the / character. Note: If the Auto-generate password check box is selected, then the instance displays the new password. The user must click Done to go to the URL.</td>
</tr>
<tr>
<td>Minimum verifications</td>
<td>Number of verifications that a user must successfully submit to reset the password. If the number exceeds the number of mandatory verifications, then the user must submit enough additional optional verifications to meet the number specified for Minimum verifications. Note: Each user must submit all mandatory verifications regardless of the number specified. By default, during the password reset process, the system presents optional verifications to the user based on the Order values for the verifications. If you selected Allow user to choose from optional verifications, then the Verification page presents all optional verifications to the user. The user then selects the appropriate number of verifications. In this example, the Minimum verifications value is 1. Because no mandatory verifications are configured, the user can choose an optional verification. Also, see Allow user to choose from optional verifications.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>Allow user to choose from optional verifications</td>
<td>Select the check box to enable a user, on the Verifications page during the process of resetting the password, to select which optional verifications to use. The choice of optional verifications appears only if the <strong>Minimum verifications</strong> setting is greater than the number of mandatory verifications. The number that you specify for <strong>Minimum verifications</strong> determines how many optional verifications that the user is allowed to select. In the example, the <strong>Minimum verifications</strong> setting is 2 and there are no mandatory verifications. The user has selected two optional verifications, so cannot select a third verification.</td>
</tr>
<tr>
<td>Email Password Reset URL</td>
<td>Select the check box to enable users to reset the password by clicking a link in an email that the instance sends to them. By default, the self-service Password Reset processes enable this option. When you select this option, the <strong>Auto-generate password</strong> check box is not available. <strong>Note:</strong> See Example: The default self-service Password Reset process for an outline of the process that is enabled by default.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable account unlock</td>
<td>This check box is available only when <strong>Password reset</strong> is selected. Select the check box to allow user accounts on credential stores to be unlocked without resetting the password.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Not supported by the default self-service Password Reset process.</td>
</tr>
<tr>
<td>Unlock user account</td>
<td>Select the check box to unlock user accounts on credential stores after a password reset.</td>
</tr>
</tbody>
</table>
| Auto-generate password | Select the check box to auto-generate a new password for the user. When this check box is selected, you must select the Email password or Display password check box, or both. This setting is useful for service desk-assisted processes. This check box is available only when:  
  • The **Password reset** check box is selected.  
  • The **Email Password Reset URL** check box is cleared. |
|                     | **Note:** If you use the credential store on your local ServiceNow instance or an Active Directory credential store: Clear the check box to enable the **Enforce history policy** option for a credential store. See Configure the connection to a credential store for the Password Reset processes. |
| User must reset password | This check box is available only when **Auto-generate password** is selected. Select the check box to require users to reset their password immediately after logging in with the auto-generated password. |
|                     | **Note:** Users whose credentials are held in the local ServiceNow instance credential store are prompted to change their password the first time that they log in. Users whose credentials are held in an Active Directory credential store are not prompted to change their passwords in the instance. Such users must change their passwords from a computer on the domain. |
### Field | Value
---|---
**Display password** | This check box is available only when **Auto-generate password** is selected. Select the check box to display the new password on the screen. In a self-service process, the password appears on the user screen. In a service desk-assisted process, the password appears on the service desk agent screen.

**Email password** | This check box is available only when **Auto-generate password** is selected. Select the check box to email the new password to the user. The setting is useful in both self-service and service desk-assisted processes. The setting can add a layer of security by requiring that users access their email to view the password. In a service desk-assisted process, emailing the password to users ensures that only the user requesting the password reset can view the password.

### Related lists on the Details tab

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verifications</td>
<td>One or more verifications that the Password Reset process uses. See Password Reset verifications. The Verifications related list is available only after the record has been saved.</td>
</tr>
<tr>
<td>Groups</td>
<td>ServiceNow user groups to associate with the Password Reset process. The Groups related list is available only after the record has been saved and if the Apply to all users check box is cleared.</td>
</tr>
</tbody>
</table>

7. For **Password Reset**, configure settings of interest on the **Advanced** tab.

#### Advanced tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry UI macro</td>
<td>UI macro that displays a customized message to users when they access the initial Password Reset screen.</td>
</tr>
<tr>
<td>Success UI macro</td>
<td>UI macro that displays a customized message to users on the final Password Reset screen when their password is successfully reset.</td>
</tr>
<tr>
<td>Failure UI macro</td>
<td>UI macro that displays a customized message to users on the final Password Reset screen when their password reset fails.</td>
</tr>
<tr>
<td>Post reset script</td>
<td>Script include that performs actions after the Password Reset process completes whether the outcome is success or failure. For more information on customizing post processor scripts, see the Post reset script category as described in Password Reset extension script categories.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Header UI macro / Footer UI macro</td>
<td>Macros that add a header or footer to customize the appearance of the pages that end users work in while resetting a password (the Identify, Verify, and Reset pages. See Add a custom header or footer to the user pages for Password Reset.</td>
</tr>
</tbody>
</table>

8. For **Password Reset**, fill in any fields of interest on the **Enrollment Reminder** tab.
10. From the **Password Reset Process Verifications** related list, select one or more verifications. See **Password Reset verifications**.
11. Optional: From the **Password Reset Process Groups** related list, select the user groups that will use the process that you are defining.
   
   The **Password Reset Process Groups** related list appears only if the **Apply to all users** check box is not selected.
12. Save the record and then select the **Active** check box to enable the Password Reset process that you configured. The check box is available only after the record has been saved.
13. **Click Update**.
14. Navigate to **Password Reset > Properties** to set the properties that configure the Password Reset experience for end users.

### Credential stores for Password Reset

Credential stores hold user information such as user names and passwords that can be used as login credentials. Examples include the User table [sys_user] or an Active Directory server.

Users with the `password_reset_admin` or `password_reset_credential_manager` role can create and modify connections to credential stores.
Credential store types installed with the base system

A credential store type is a set of workflows that specify how to connect to a credential store. Navigate to Password Reset > Credential Stores to view the list of example credential stores that are based on the base-system types. The base system includes the following credential store types:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local ServiceNow Instance</td>
<td>Represents the current (local) ServiceNow instance.</td>
</tr>
<tr>
<td>AD Credential Store</td>
<td>Represents an Active Directory credential store. Installed with the Password Reset - Orchestration Add-on plugin.</td>
</tr>
</tbody>
</table>

Connection workflows for credential store types

A credential store type workflow requires a subflow that defines how to connect to the store, and can include an optional subflow that defines how to test the connection. Use the Pwd reset – AD and Pwd Reset - Local subflows as models for your custom connection workflows.

Pwd Reset Local sub workflow
Creating a custom credential store type

You can use a credential store type as a model to create a custom type. See Create a credential store type for Password Reset.

Configure the connection to a credential store for the Password Reset processes

You create a Password Reset credential store record to configure access to your credential store server while a user is changing or resetting a password. In addition to host connection information, you can specify the password hints that users should see, restrictions on password reuse, the allowed number of failed reset attempts, and other settings.

For an AD credential store, skip this procedure and instead follow the instructions in Integrate Password Reset with your Active Directory service. The Password Reset Windows Application supports only AD credential stores.

1. Navigate to Password Reset > Credential Stores.
2. Select one of the following sample credential stores:
   - Local ServiceNow Instance credential store.
   - Remote (SOAP) ServiceNow credential store (installed with the Orchestration Add-on).
3. Enter a unique and meaningful **Name** and **Description**, and then fill in the form.

<table>
<thead>
<tr>
<th><strong>Type</strong></th>
<th>Type of credential store that you are connecting to. A ServiceNow credential store type is a template that provides the required set of capabilities for a particular kind of credential store. Credential stores inherit the functionality of the credential store type.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> For an AD credential store, skip this procedure and see Integrate Password Reset with your Active Directory service. The Password Reset Windows Application supports only AD credential stores.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Auto-generator password</strong></th>
<th>Script include that generates a temporary password for use during the reset process.</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you select the <strong>Enforce history policy</strong> check box, then you must specify a value for <strong>Auto-generate password</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Enforce history policy</strong></th>
<th>Appears only if you select a credential store <strong>Type</strong> of <strong>AD Credential Store</strong> or <strong>Local ServiceNow Instance</strong>. For information on configuring the setting for an AD credential store, see Configure the connection to an AD credential store.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the <strong>Enforce history policy</strong> check box to ensure that users do not reuse passwords. For example, you might configure the history policy to not allow the user to reuse any of the previous 10 passwords. Follow this procedure:</td>
<td></td>
</tr>
<tr>
<td>a. Select the <strong>Enforce history policy</strong> check box.</td>
<td></td>
</tr>
<tr>
<td>b. In the Password Reset Credential Store Parameters related list, create a <strong>password_history_limit</strong> parameter.</td>
<td></td>
</tr>
<tr>
<td>c. Set the value of the parameter to the number of previous passwords that cannot be used (maximum 10). The default value of 0 (zero) enables use of any previous password.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Hostname</strong></th>
<th>URL or IP address of the credential store.</th>
</tr>
</thead>
</table>

| **User account lookup** | Script include that maps the user ServiceNow platform ID to the user credential store ID. A default script, **PwdDefaultUserAccountLookup**, returns the user ServiceNow platform user name. |

<table>
<thead>
<tr>
<th><strong>Password rule hint</strong></th>
<th>Specify the text that appears on the password reset page to help the user to create a password that meets all requirements. The <strong>Password rule</strong> script enforces the requirements.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> The Password Reset Windows Application supports newline characters in the hint. Other formatting is not supported (bold, underline, hyperlink, and so on).</td>
<td></td>
</tr>
</tbody>
</table>

| **Password rule** | Specify the client script that validates the new password that the user enters. The script is invoked when the user enters a new password and clicks **Password Reset**. You can use the script to enforce password strength/complexity requirements. |

<table>
<thead>
<tr>
<th><strong>Enable Password Strength</strong></th>
<th>Select the check box to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Display the text box for the <strong>Strength rule</strong> script so you can update the script.</td>
<td></td>
</tr>
<tr>
<td>• Display the graphical <strong>Password Strength</strong> bar to the user while the user changes or resets the password.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> The Password Reset Windows Application does not support Password Strength.</td>
<td></td>
</tr>
</tbody>
</table>
4. Click **Submit**.

5. If you use the Local ServiceNow Instance credential store and you selected the **Enforce history policy** check box, then follow these steps:
   a) Open the Password Reset process that is associated with the credential store: **Password Reset > Processes**.
   b) On the **Password Reset Details** tab of the Password Reset Process form, clear the **Auto-generate password** check box and then save the process definition.

6. **Test the connection to the credential store.**

   **Integrate Password Reset with your Active Directory service**
   When the Orchestration Add-on plugin is activated, the Password Reset application can change passwords on an Active Directory credential store. The application changes passwords by referencing an Active Directory user role with the appropriate password change privileges.

   Role required: admin

   Active Directory must have a user role with the following privileges:

   Descendent User objects:
   - Reset password
   - Read/Write pwdlastset
   - Read/Write UserAccountcontrol
   - Write Account Restrictions
   - Read/Write lockouttime
   - Read MemberOf
Descendent Group objects:

- Read Members
- Read MemberOf

1. **Install a MID Server** on a Windows computer that can connect to Active Directory.
2. **Configure the MID Server.**
3. In the ServiceNow instance, navigate to **Orchestration > Credentials.**
4. Click **New**, complete the form with the following values for the AD credential, and then click **Submit**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select Windows.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter your Active Directory domain user. For example, <code>domain\admin</code>.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter your Active Directory domain user password.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the MID Server that is used to access the Active Directory server.</td>
</tr>
</tbody>
</table>

Create a connection to the credential store as described in **Configure the connection to an AD credential store.**

**Configure the connection to an AD credential store**

You create a Password Reset credential store record to configure access to your Active Directory server while a user is changing or resetting a password. In addition to host connection information, you can specify the password hints that users should see, restrictions on password reuse, the allowed number of failed reset attempts, and other settings.

The Orchestration add-on installs the AD Credential Store type. The Password Reset Windows Application supports only **AD Credential Store.**

1. Navigate to **Password Reset > Credential Stores** and select **Sample AD Credential Store** to use as a template.
2. Enter a unique and meaningful **Name** and **Description** and then fill in the form.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto-generate password</strong></td>
<td>Specify a script include that generates a temporary password for use during the reset process.</td>
</tr>
</tbody>
</table>

**Note:** If you select the **Enforce history policy** check box, then you must specify a value for **Auto-generate password.**
Enforce history policy

Appears only if you select a credential store Type of AD Credential Store or Local ServiceNow Instance. For information on configuring the setting for credential store types other than AD, see Configure the connection to a credential store for the Password Reset processes.

Select the Enforce history policy check box to enforce both of the following password reset policies:

- History policy (password reuse): Active Directory domains can be configured to include a history policy that ensures that users do not reuse passwords. For example, the history policy might be configured to not allow the user to reuse any of the previous 10 passwords when resetting a password.
- Maximum number of reset attempts: You can configure the maximum number of attempts to reset a password. A user who fails to reset the password (by failing password policies or the history policy) the specified number of times is blocked.

Follow this procedure to enforce the history policy that is configured for the AD credential store and to enforce the password policy:

a. Select the Enforce history policy check box.

b. In the Password Reset Credential Store Parameters related list, set the value of the max_reset_attempts parameter to the number of allowed attempts to change or reset the password. Attempts fail when password policies which are set up on the remote AD server. The max_reset_attempts setting applies only to Password Reset processes that use AD credential stores. The default value of 0 (zero) enables an unlimited number of reset attempts.

<table>
<thead>
<tr>
<th>Hostname</th>
<th>Specify the URL or IP address of the credential store.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User account lookup</td>
<td>Specify the script include that maps the user ServiceNow platform ID to the user credential store ID. The default script, PwdDefaultUserAccountLookup, returns the user ServiceNow platform user name.</td>
</tr>
<tr>
<td>Password rule hint</td>
<td>Specify the text that appears on the password reset page to help the user to create a password that meets all requirements. The Password rule script enforces the requirements.</td>
</tr>
<tr>
<td>Password rule</td>
<td>Specify the client script that validates the new password that the user enters. The script is invoked when the user enters a new password and clicks Password Reset. You can use the script to enforce password strength/complexity requirements.</td>
</tr>
<tr>
<td>Enable Password Strength</td>
<td>Select the check box to:</td>
</tr>
<tr>
<td></td>
<td>• Display the text box for the Strength rule script so you can update the script.</td>
</tr>
<tr>
<td></td>
<td>• Display the graphical Password Strength bar to the user while the user changes or resets the password.</td>
</tr>
</tbody>
</table>

Note: The Password Reset Windows Application supports newline characters in the hint. Other formatting is not supported (bold, underline, hyperlink, and so on).

Note: The Password Reset Windows Application does not support Password Strength.
3. Click **Submit**.

4. On the domain controller, set **Password Aging** (MIN_PASSWORD_AGE) to zero.

5. To enforce the history policy that is configured for the AD credential store, follow these steps:
   a) Open the Password Reset process that is associated with the credential store: **Password Reset > Processes**.
   b) On the **Password Reset Details** tab of the Password Reset Process form, clear the **Auto-generate password** check box and then save the process definition.
   c) On the domain controller, set the history policy to twice the desired number of passwords. For example, to enforce that the last 11 passwords are not repeated, set the history policy to 22.

   **Note:** To enforce the history policy that is configured for the AD credential store, the system auto-generates a new temporary password for each reset cycle. The system auto-generates the temporary password even though you cleared the **Auto-generate password** check box on the Password Reset Process form. Because the user immediately replaces the temporary password with a new password, two passwords are created for each reset cycle.

6. To enforce the maximum number of attempts to reset the password: In the Password Reset Credential Store Parameters related list, set the value of the **max_reset_attempts** parameter to the number of allowed failed attempts. The default value of 0 (zero) enables an unlimited number of reset attempts.

   **Note:** The **max_reset_attempts** setting applies only to Password Reset processes that use AD credential stores.

7. Click **Submit**.
8. Test the connection to the credential store.

_Test the connection to a credential store_
You should test the connection to a credential store after you configure a new credential store or when users experience problems that might involve the connection.

Role required: admin

1. Navigate to **Password Reset > Credential Stores** and then open the credential store record.
2. In the header bar, click **Save and Test Connection**.
   A progress page displays the result of the test.

_Set up SOAP credentials for Password Reset_
When the Orchestration Add-on plugin is activated, the ServiceNow platform can use the SOAP protocol to interact with remote credential stores such as a remote ServiceNow instance.

Role required: admin or web_service_admin

1. Navigate to **System Web Services > Outbound > SOAP Message**.
2. Click **Password Reset Request**.
3. From the **Soap Message Functions** related list, configure both the **password_reset** and **sys_user_get_record** functions by completing the following steps.
   a) In **Basic auth user ID**, enter the user ID for the remote system user who has privileges to update records on the User [sys_user] table.
   b) In **Basic auth user password**, enter the password for the remote system user who has privileges to update records on the User [sys_user] table.
   c) Select **Use basic auth**.
   d) Click **Update**.

   You do not need to enter a value in the **SOAP endpoint** field. The field shows the name of the ServiceNow instance used for Password Reset.

_Delete a connection to a credential store for Password Reset_
Important: Before you delete the connection to a credential store, check all Password Reset processes to ensure that the credential store is not in use. If the credential store is being used by a process, update the process before deleting the credential store.

Role required: password_reset_admin or password_reset_credential_manager

1. Navigate to **Password Reset > Credential Stores** and then select the check box for the credential store.
2. In the **Actions** choice list, select **Delete**.

_Password Reset verifications_
Each **verification** specifies the method and process for verifying the identity of the user that is requesting password reset.

Verifications included with Password Reset
The Password Reset application includes the following verifications in the base system. You can create a verification based on either a base-system verification or a verification type (a template).

**Note:** The Password Reset Windows Application does not support custom verifications.
### Password Reset verifications

<table>
<thead>
<tr>
<th>Verification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>QA verification</td>
<td>Implements a self-service Password Reset model with questions that are included with the base system or custom questions that the admin defines. While enrolling for the process, the user decides which questions to provide answers for. Questions are presented in the language that the user requested during login. When a user requests password reset, the system poses a specified number of the questions that the user selected during enrollment. The user must answer all questions correctly to verify identity.</td>
</tr>
<tr>
<td>Email verification</td>
<td>This verification relies on auto-generated code numbers. You typically implement Email verification as a self-service Password Reset model. When a user requests password reset, the system sends a verification code to an email address that the user authorized during enrollment. To verify identity, the user then submits the code on the Password Reset Verify page. For information on the user enrollment experience, see Users: Enroll in the Password Reset program using emailed codes. The Password Reset Windows Application supports Email verification. This verification is based on the Email Code verification type.</td>
</tr>
<tr>
<td>SMS verification</td>
<td>Implements a self-service or service desk-assisted Password Reset model that relies on auto-generated code numbers. When a user requests password reset, the system sends a code to an SMS-capable device that the user has authorized. To verify identity, the user then submits the code on the Password Reset Verify page. You can use the ServiceNow Notify feature to send the codes. For information on the user enrollment experience, see Users: Enroll in the Password Reset program using SMS codes. This verification is based on the SMS Code verification type.</td>
</tr>
</tbody>
</table>

For information on the user enrollment experience, see Users: Enroll in the Password Reset program using questions and answers.

This verification is based on the Security Questions verification type.
Verifications included with the demo data

The following demo data is based on the Mock verification type:

- Sample Mock verification #1
- #2

Personal data identification types and confirmation type verifications

Personal data verifications allow users to verify their identity by providing answers to questions that are generated from personal information stored in the User table [sys_user].

User experience

For an example of how a user might enroll for Personal data verification, see Users: Enroll in the Password Reset program using questions and answers.

Personal data identification types

The Password Reset application provides the email and username identification types. You can use either type as provided or as a model to create a custom identification type.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Identification</td>
<td>Identifies users by their email addresses.</td>
</tr>
<tr>
<td>Username Identification</td>
<td>Identifies users by their user names.</td>
</tr>
</tbody>
</table>
Personal data confirmation verifications

- **Personal data verification**: If users are associated with a Password Reset process that uses a personal data verification, the users are typically not required to enroll for Password Reset.
- **Personal data confirmation verifications** allow employees with the `password_reset_service_desk` role to access personal data from the `sys_user` table when assisting a user with a password reset request.

To configure personal data and personal data confirmation verifications, you specify parameters as name/value pairs that correspond to a particular piece of user information. For example, to verify users by their email address:

1. Set the **label** parameter (the text that the end user should see) to **Email** (that is, `label=Email`).
2. Set the **column** parameter (the column in the table that holds the verification data) to **email** (that is, `column=email`).

**Note**: You can use only one set of name/value pair parameters per verification. Additional parameters are ignored.

To use multiple pieces of personal information for user verification, create more personal data or personal data confirmation verifications and add the verifications to the related Password Reset process.

### Personal data and personal data confirmation type verifications

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>label</td>
<td>Text to display as a label for the field that the user fills in during the password reset request. Data Type: string Default Value: n/a</td>
</tr>
<tr>
<td>column</td>
<td>Column of the <code>sys_user</code> table that provides the data that is used to verify the identity of the user. Data Type: string Default Value: n/a</td>
</tr>
</tbody>
</table>

**SMS Code Verification type for Password Reset**

Using the Simple Message Service (SMS) Code Verification type, a user can verify identity with the help of any SMS-enabled device, like a cell phone that accepts text messages. When a user requests password reset, the system sends a numerical code to the device and the user then enters the code on the Password Reset Verification page.

You can change the default behavior of an SMS code verification using either of the following methods:

- Set parameter values, as shown in the table.
- Update property settings for the Password Reset application.

**Note**: The system allows only one instance of each SMS code parameter.
SMS Code Verification type parameters

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Description</th>
<th>Data Type</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>expiry</td>
<td>Number of minutes the verification code is valid.</td>
<td>integer (any positive integer)</td>
<td>5</td>
</tr>
<tr>
<td>complexity</td>
<td>Number of digits in the numerical verification code.</td>
<td>integer (any positive integer)</td>
<td>4</td>
</tr>
<tr>
<td>pause_window</td>
<td>Number of minutes before the user can request another SMS code for verification.</td>
<td>integer (any positive integer)</td>
<td>2</td>
</tr>
<tr>
<td>max_per_day</td>
<td>Maximum number of codes sent for verification in one day.</td>
<td>integer (any positive integer)</td>
<td>10</td>
</tr>
</tbody>
</table>

User experience

For information on how users enroll for SMS verification, see Users: Enroll in the Password Reset program using SMS codes.

Use NotifyNow to send SMS codes for enrollment and verification

You can configure the Password Reset application to send SMS codes for enrollment and verification using the ServiceNow NotifyNow application (via the Twilio SMS Messaging system). NotifyNow is tightly integrated with the workflow engine and business rules and delivers a highly configurable and trusted way to deliver SMS messages.

Role required: admin

NotifyNow requires a separate contract with Twilio.

1. Enroll for a Twilio account and telephone number at https://www.twilio.com/
2. Activate the Notify plugin.
3. Associate the Twilio account with Notify.

No other configuration is required. Users who request password change or password reset receive SMS codes through NotifyNow.

Specify the number of required security questions

When designing a Security Questions verification for Password Reset, you can specify the number of questions to display when users enroll. You can also specify the number to display when a user is verifying identity while resetting the password.

Role required: password_reset_admin or admin

1. Navigate to Password Reset > Verifications and then open a verification that uses the Security Questions Verification Type.
2. Configure the parameters in the **Password Reset Verification Parameters** related list.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>num_enroll</td>
<td>Number of questions that a user must provide answers to while enrolling for the Password Reset process. The value that you specify here overrides the setting of the <strong>Number of security questions required during enrollment</strong> property. See Configure Password Reset properties. Data Type: Positive integer that does not exceed the number of questions in the security questions list (Password Reset &gt; Security Questions). Default Value: 5</td>
</tr>
<tr>
<td>num_reset</td>
<td>Number of security questions that are displayed on the Verify page while a user is attempting to reset the password. The user must answer all questions correctly to verify identity. The questions are selected at random and are presented in random order. The value that you specify here overrides the setting of the <strong>Number of security questions required during the password reset request</strong> property. See Configure Password Reset properties. Data Type: Positive integer that does not exceed the value of the num_enroll parameter Default Value: 3</td>
</tr>
</tbody>
</table>

3. Click **Update**.

**Configure your Password Reset process to auto-enroll users**

To simplify management, many organizations auto-enroll users in the Password Reset program. Every base-system verification type enables you to specify automatic enrollment for your process.

Role required: password_reset_admin or admin

To enable automatic enrollment, you configure settings for the verification type that your Password Reset process is based on.

1. Navigate to **Password Reset > Extensions > Verification Types**.
2. Click the verification type for the verification that your Password Reset process uses. The verification type for each base-system verification is identified in **Password Reset verifications**.
3. On the **Verification Types** page, specify the following settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment check</td>
<td>Script that determines whether a user is enrolled for verification.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For automatic enrollment to work, the <strong>Enrollment check</strong> script must return true. This may require additional setup by the admin to ensure that the preconditions are met. For example, for the <strong>SMS Code</strong> verification type, records must be populated in particular tables.</td>
</tr>
<tr>
<td>Automatic enrollment</td>
<td>Select the check box to auto-enroll users.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If <strong>Automatic enrollment</strong> is not selected, then you must provide an enrollment UI macro and enrollment processor script as described in Create a custom Password Reset verification type.</td>
</tr>
</tbody>
</table>

4. Repeat the procedure for all verifications that your Password Reset process uses.

**Enable users to enroll for Password Reset**

To enable users to enroll for the Password Reset program, you specify a UI macro that takes the user through the enrollment process and a script that processes the enrollment data that the user entered. The base system includes a functioning macro and script.

Role required: password_reset_admin or admin

To enable users to enroll, you configure settings for the verification type that your Password Reset process is based on.

1. Navigate to **Password Reset > Extensions > Verification Types**.
2. Click the verification type for the verification that your Password Reset process uses. The verification type for each base-system verification is identified in **Password Reset verifications**.
3. On the **Verification Types** page, specify the following settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic enrollment</td>
<td>Clear the check box to disable automatic enrollment.</td>
</tr>
<tr>
<td>Enrollment UI</td>
<td>Enrollment UI macro that takes the user through the enrollment process.</td>
</tr>
<tr>
<td>Enrollment processor</td>
<td>Enrollment processor script that processes enrollment data.</td>
</tr>
</tbody>
</table>

4. Repeat the procedure for all verifications that your Password Reset process uses.

**Enabling user enrollment**

This example verification type uses the `pwd_enroll_sms_ui` enrollment UI macro and the `PwdEnrollSMSProcessor` enrollment processor script.
A verification type must also define a verification UI macro and a corresponding verification processor script. The example uses the `pwd_verify_sms_ui` verification UI macro and the `PwdVerifySMSProcessor` verification processor script.
### Verification UI Macro

Handle SMS verification method experience

```xml
<%xml version="1.0" encoding="utf-8" %>
<%@jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:x="null" xmlns:s="null">
<script language="javascript">
addLoadEvent(getVerificationInfo);

function getVerificationInfo() {
    var ga = new GlideAjax('PwdAjaxPublicEnrollSMS');
    ga.addParam('sysparm_name', 'getSMSVerificationInfo');
    ga.addParam('sysparm_user_id', '$(sysparm_sys_user_id)');
    // add CSRF token for AJAX handling.
    ga.addParam('sysparm_pwd_csrf_token', findCSRFElement().value);
    ga.getXML(handleGetVerificationInfoResponse, null);
}

function handleGetVerificationInfoResponse(response, args) {
```

---

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Verification processor script

Configure Password Reset properties

You can specify properties that configure the Password Reset experience for end users.

Role required: password_reset_admin
While there are no range limits for the values you can enter for properties, consider using only positive integer values starting at 1. When you determine the limit for the upper range of a property, consider the task that the user is performing.

For example, you would not want to allow 100 attempts for users to verify their identity. A more common value is 3 attempts. Similarly, you may not want to force users who are completing the enrollment process to spend time selecting and answering 30 security questions. The more commonly used number of security questions is between 5 and 7.

1. Navigate to **Password Reset > Properties**.
2. Update settings as needed and then click **Save**.

### Password Reset properties

<table>
<thead>
<tr>
<th>Property Label</th>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email template for reminders to users who need to enroll for the password reset process</strong></td>
<td>password_reset.enrollment_reminder.email_template</td>
<td>Template to use for the email messages that remind users to enroll for the password reset process. See <a href="#">Send email to remind users to enroll for Password Reset</a>.</td>
</tr>
<tr>
<td><strong>Workflow polling frequency</strong></td>
<td>password_reset.wf.refresh_rate</td>
<td>Time period in milliseconds between checks on status of the Password Reset workflow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 500</td>
</tr>
<tr>
<td><strong>Workflow expiration</strong></td>
<td>password_reset.wf.timeout</td>
<td>Maximum wait time in milliseconds for the workflow to complete. The workflow is triggered during the password reset request when the user clicks <strong>Submit</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 90000</td>
</tr>
<tr>
<td><strong>Disable CAPTCHA validation functionality</strong></td>
<td>password_reset.captcha.ignore</td>
<td>Enables or disables CAPTCHA functionality.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: true/false</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Password Reset application uses Google reCAPTCHA as the default CAPTCHA service. To use the base system CAPTCHA, change the system property to <strong>false</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See <a href="#">Configure Google reCAPTCHA</a>.</td>
</tr>
<tr>
<td>Property Label</td>
<td>Property Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>---------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password Reset Request properties</td>
<td></td>
<td>Number of password reset attempts a user is allowed before they are locked out for a period determined by the value in <code>max_attempt_window</code>.</td>
</tr>
</tbody>
</table>
| Number of unsuccessful attempts allowed to reset/change password | `password_reset.request.max_attempt`                | • Type: integer  
• Default value: 3 (attempts)                                                                                                                  |
| Number of minutes a user must wait to reset/change password after exceeding the maximum allowed unsuccessful attempts | `password_reset.request.max_attempt_window`         | Time period that users are blocked or prevented from changing their passwords after trying the maximum number of times.                                                                               |
|                                                   |                                                   | • Type: integer  
• Default value: 1440 (minutes)                                                                                                                |
| Number of minutes a user must wait to reset/change password after the last successful reset/change | `password_reset.request.success_window`              | Time period that a user must wait after successfully resetting the password to reset the password again.                                                                                                  |
|                                                   |                                                   | • Type: integer  
• Default value: 1440 (minutes)                                                                                                                |
| Number of minutes a user must wait to start a reset request after the last successful unlock account | `password_reset.request.unlock_window`               | Time period that a user must wait after a successful unlock operation before starting a new request.                                                                                                    |
|                                                   |                                                   | • Type: integer  
• Default value: 1440 (minutes)                                                                                                                |
| Number of minutes before a password reset request expires | `password_reset.request.expiry`                     | Time period during which a user must perform the Password Reset process.                                                                                                                                  |
|                                                   |                                                   | • Type: integer  
• Default value: 10 (minutes)                                                                                                                  |
<p>| Note: This setting takes precedence over the <code>glide.pwd_reset.onetime.token.validity</code> property (that has a 12-hour default). |                                                   |                                                                                                           |</p>
<table>
<thead>
<tr>
<th>Property Label</th>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum number of characters in any answer</td>
<td>password_reset.qa.ans_min_len</td>
<td>Minimum number of alphanumeric characters that the user must enter in the answer text box for any security question. Default value: 3 characters</td>
</tr>
<tr>
<td>Number of security questions required during the password reset request</td>
<td>password_reset.qa.num_reset</td>
<td>Number of security questions that are displayed on the Verify page while a user is attempting to reset the password. The user must answer all questions correctly to verify identity. The questions are selected at random and are presented in random order.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 3 (questions)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Possible values: Integers that are less than the number specified for the <strong>Number of security questions required during enrollment</strong> property (the <code>num_enroll</code> parameter).</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> You can override this property setting for a Password Reset process by configuring the <code>num_reset</code> parameter. See <strong>Specify the number of required security questions</strong>.</td>
</tr>
<tr>
<td>Property Label</td>
<td>Property Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Number of security questions required during enrollment | password_reset.qa.num_enroll | Number of questions that a user must provide answers to while enrolling for the Password Reset process.  
- Type: integer  
- Default value: 5  
- Possible values: Integers that are greater than or equal to the number specified for the Number of security questions required during enrollment property (the num_reset parameter). |

**Note:** While attempting to verify identity, if a user answers a question incorrectly, the application refreshes with a random set of the specified questions in random order. You should, therefore, require more questions than specified for the Number of security questions required during enrollment property (the num_reset parameter).

**Note:** You can override this property setting for a Password Reset process by configuring the num_enroll parameter. See Specify the number of required security questions.
<table>
<thead>
<tr>
<th>Property Label</th>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum number of SMS codes sent for verification per day                    | password_reset.sms.max_per_day                    | Maximum number of SMS codes that are sent to a user within one 24-hour period. The 24-hour period begins when a user clicks **Send Code**.  
• Type: integer  
• Default value: 10 (per day)  

**Note:** You can override this SMS code property by adding the `max_per_day` parameter in the SMS code verification. |
| Number of minutes before the user can attempt to send another SMS code for verification | password_reset.sms.pause_window                  | Time that must pass before another SMS code can be sent to a user.  
• Type: integer  
• Default value: 2 (minutes)  

**Note:** You can override this SMS code property by adding the `pause_window` parameter in the SMS code verification. |
| Number of digits in the SMS code sent to the user                           | password_reset.sms.default_complexity             | Number of characters required for a user to reset their password.  
• Type: integer  
• Default value: 4 (digits)  

You can override this SMS code property by adding the `complexity` parameter in the SMS code verification. |
<table>
<thead>
<tr>
<th>Property Label</th>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of minutes before the SMS code expires</td>
<td>password_reset.sms.expiry</td>
<td>Time, in minutes, until the SMS code sent to the user expires.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 5 (minutes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> You can override this SMS code property by the <code>expiry</code> parameter in the SMS code verification.</td>
</tr>
<tr>
<td>Password Reset Monitoring and Reporting properties</td>
<td>password_reset.activity_monitor.incident_window</td>
<td>Time window to count the number of blocked users.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 60 (minutes)</td>
</tr>
<tr>
<td>Number of blocked users, in the defined time interval, that triggers a system log event</td>
<td>password_reset.activity_monitor.incident_threshold</td>
<td>Number of blocked (or locked) users, within the specified time window, that triggers a system log event.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 10 (blocked users)</td>
</tr>
<tr>
<td>Password Reset Style Sheet</td>
<td>password_reset.stylesheet</td>
<td>Name of a custom CSS style sheet in the Style Sheet [content_css] table. You can use the default style sheet as a template for the custom style sheet. You cannot add element definitions to the style sheet.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: <code>css_pwd_reset_default</code></td>
</tr>
<tr>
<td>Property Label</td>
<td>Property Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>---------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Email template for reminder emails</td>
<td>password_reset.email_template_default</td>
<td>Template to use to specify the subject and body of the email messages to remind users to enroll for the Password Reset process. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• [Subject] Reminder: Enroll in the Password Reset program</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• [Body] Click here to enroll for the password reset service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: You must create an email template in the password_reset table to use it as a reminder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: email_template_default</td>
</tr>
</tbody>
</table>

**Note:** Several components in the Self Service Password Reset (com.snc.password_reset) plugin and the Password Reset (com.glideapp.password_reset) plugin control the password reset flow. The following properties affect Password Reset, but do not appear on the Password Reset > Properties page:

- You can add the glide.pwd_reset.onetime.token.validity property to the System Properties [sys_properties] table to specify the number of hours that the Password Reset token should be valid. Default: 12.

**Note:** The setting for the password_reset.request.expiry property (time period during which a user must perform the Password Reset process) takes precedence over the setting for glide.pwd_reset.onetime.token.validity.

Properties accessible from the System Properties [sys_properties] table:

- For Password Reset on mobile devices, you can specify the URL that the user is taken to when user taps the Forgot password? button. See the glide.security.password_reset.uri property in High Security Settings. Default: /$pwd_reset.do?sysparm_url=ss_default
- If glide.security.forgot_password.display.link is set to true, displays the Forgot Password? link on the login page.

---

**Send email to remind users to enroll for Password Reset**

You can automatically send messages that remind users to enrolled in the Password Reset process. You specify the text of the message and can configure the messages to repeat at intervals.
Role required: password_reset_admin

The default email content is:

- **Subject:** Reminder: Enroll in the Password Reset program
- **Body:** Click here to enroll in the Password Reset program.

To customize the email, see [Customize the Password Reset enrollment reminder email](#).

1. Navigate to **Password Reset > Processes** and select your process.
2. Click the **Enrollment Reminder** tab, configure the following settings, and then click **Update**. (The tab appears only when the **Password reset** check box is selected.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send reminder</td>
<td>Select the check box to send reminder emails to users (either all users or users in the specified groups, as you configured). Clear the check box to send no reminders.</td>
</tr>
</tbody>
</table>
| Sender alias  | Enter a non-functional email alias that should appear in both the **To** and **From** fields of the message. For example, do-not-reply@myCompany.com. Users will not be able to respond to the alias.  

The alias is required by the email system to use the **bcc** field for all of the users who receive the message. The intent is that the users should not see the other addressees.  

Default: do-not-reply@ServiceNow.com |
| Send, Day, and Time | Specify a schedule of one message each month or one message each week.  

- If you set **Send** to **Monthly**, then enter the day of the month and optionally the time of day when the message should be sent.  
- If you set **Send** to **Weekly**, then enter the day of the week and optionally the time of day when the message should be sent.  

Default: Weekly message at 00:00 on Monday |
| Starting | Date and time to send the first message. Click the calendar button to specify the setting.  

Default: [Now] |

[Customize the Password Reset enrollment reminder email](#)

The email message that reminds users to enroll for the Password Reset process is based on an email template. To customize the message, you can modify the default template or create a custom template.

Role required: password_reset_admin

The default email content is:

- **Subject:** Reminder: Enroll in the Password Reset program
• Body: Click here to enroll in the Password Reset program.

1. To modify the email subject text:
   a) Navigate to System Policy > Email > Templates.
   b) Open the Password reset enrollment reminder template.
   c) Update the Subject field as needed.
   d) In the Message HTML text box, you can add code as needed, but do not modify the default text.
2. To modify the email body content:
   a) Navigate to System Notifications > Email > Notification Email Scripts.
   b) Open the pwd.enrollment_reminder script.
   c) Modify only the indicated portion of the script.
```javascript
function runMailScript(/* GlideRecord */ current, /*
    TemplatePrinter */ template,
    // Optional: EmailOutbound = email, // Optional
    // GlideRecord = email_action,
    // Optional: GlideRecord = event) {
    var board = "Password Reset Notification -do-not-reply@servicenow.com";
    email.setFrom(board);
    email.setReplyTo(board);

    var users = event parm2.split(\"\");

    // get user records
    var user = new GlideRecord("sys_user");
    user.addFilter("sys_id", users);
    user.query();

    while (user.next()) {
        var user_email = user.getEmail();
        user.setEmail(user_email);
        user.getDisplayValue();

        var enrollmentURL = gs.getProperty("glide.servlet.uri") + "pwd_enrollment_form_container.do";
        template.print("Click <a href=" + enrollmentURL + ") here</a> to enroll for the password reset service.\n    }

}(current, template, email, email_action, event);
```
3. To create a custom email template:
   a) Make a copy of the Password reset enrollment reminder template and edit as described above.
   b) Navigate to Password Reset > Properties and enter the template name in the Email template for enrollment reminder emails field.

Configure the required strength for passwords

The password that a user defines must meet certain requirements — for example, it must contain at least 12 characters, it must include a numeral, and so on. You can configure the requirements as needed for your organization.

Role required: password_reset_admin

The base system includes example credential stores with various password requirements. You can modify password requirements and provide users with hints for creating a password. The default requirements are:

• At least eight characters
• At least one uppercase and one lower case letter
• At least one numeral

Note: In addition to configuring password strength requirements, you can configure several other settings for the credential store, as described in Configure the connection to a credential store for the Password Reset processes.

1. Navigate to Password Reset > Credential Stores.
2. Select the credential store in the list and then configure the following settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password rule hint</td>
<td>Specify the text that appears on the password reset page to help the user to create a password that meets all requirements. The Password rule script enforces the requirements.</td>
</tr>
<tr>
<td></td>
<td>Note: The Password Reset Windows Application supports newline characters in the hint. Other formatting is not supported (bold, underline, hyperlink, and so on).</td>
</tr>
<tr>
<td>Password rule</td>
<td>Specify the client script that validates the new password that the user enters. The script is invoked when the user enters a new password and clicks Password Reset. You can use the script to enforce password strength/complexity requirements.</td>
</tr>
<tr>
<td>Enable Password Strength</td>
<td>Select the check box to:</td>
</tr>
<tr>
<td></td>
<td>• Display the text box for the Strength rule script so you can update the script.</td>
</tr>
<tr>
<td></td>
<td>• Display the graphical Password Strength bar to the user while the user changes or resets the password.</td>
</tr>
<tr>
<td></td>
<td>Note: The Password Reset Windows Application does not support Password Strength.</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Strength rule    | This text box appears only if you select **Enable Password Strength**. Specify the client script that calculates the strength/complexity of the password that the user enters. The script is invoked when the user begins to enter a new password during the reset process. Default settings:  
  • Selected for local ServiceNow credential stores  
  • Not selected for other credential stores |

**Note:**
To guide the user during the reset process, the system displays a graphical bar labeled **Password Strength** under the **New password** field.

**Note:** The Password Reset Windows Application does not support Password Strength.

---

3. Click **Submit**. You should test the connection to a credential store after you configure a new credential store or when users experience problems that might involve the connection.

4. Navigate to **Password Reset > Credential Stores** and then open the credential store.

5. In the header bar, click **Save and Test Connection**. A progress page displays the result of the test.

---

### Specify lockout for failed login attempts

The system provides inactive script actions that enable you to specify the number of failed login attempts before a user account is locked and to reset the count after a successful login.

Role required: admin

Navigate to **System Policy > Script Actions** to view or activate the scripts.

**Note:** Starting with the Kingston release, following a zBoot, the script actions **SNC User Lockout Check with Auto Unlock** and **SNC User Clear** are activated.
To learn more about properties that affect failed login attempts, see #unique_2431 in the Instance Security Hardening Settings.

<table>
<thead>
<tr>
<th>Script action</th>
<th>Description</th>
</tr>
</thead>
</table>
| SNC User Lockout Check with Auto Unlock            | • Uses the value of the glide.user.max_unlock_attempts property to set the limit for failed login attempts.  
  • Unlocks the user account after the time period that is specified for the glide.user.unlock_timeout_in_mins property. If no value is specified, then the system unlocks the user account after the default period of 15 minutes. |
| SNC User Lockout Check                             | Tracks the number of failed login attempts and locks the user account after a specified number of failed login attempts (default: 5). |
| SNC User Clear                                     | Updates the user record after a successful login: Resets the number of failed login attempts and updates the date of the last login. |

Each time a user attempts to log in, the action is recorded in an event log. You can view a log of failed login attempts.

1. Navigate to System Policy > Event Logs.
2. Filter for login.failed in the Name field. You can view the attempted login name, date, and IP address logged for the attempt.

Configure Google reCAPTCHA for the password reset process

To use the Google reCAPTCHA service, instances that are running on a domain other than service-now.com require an API key pair from Google.

Role required: admin

- The procedure described in this topic is optional for instances that are running on the service-now.com domain.
- Because on-premises instances do not have access to the Internet, they cannot use the Google reCAPTCHA service. Do not follow the procedure described in this topic. Instead, set the password_reset.captcha.google.enabled system property to false. This setting enables the CAPTCHA service that is provided with the base system.
- The Password Reset Windows Application uses the base-system CAPTCHA service even if the Password Reset application is configured to use Google reCAPTCHA.

1. Request an API key pair (a site key and a secret) from Google at https://www.google.com/recaptcha.
2. Set the following system properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>password_reset.captcha.google.enabled</td>
<td>Set to true.</td>
</tr>
<tr>
<td></td>
<td>Type: string</td>
</tr>
<tr>
<td></td>
<td>Default: true</td>
</tr>
</tbody>
</table>
### Property | Value
--- | ---
**google.captcha.site_key** | Set to the site key that Google provided.  
Type: string  
Default: A site key that Google provided to ServiceNow

**google.captcha.secret** | Set to the secret that Google provided.  
Type: password2  
Default: An encrypted secret that Google provided to ServiceNow

### Settings on the Advanced tab of the Password Reset Processes form

UI macros and script includes can extend the basic functionality of a Password Reset process. The Advanced tab appears when you are configuring a Password Reset process (*Password Reset > Processes*).

**Advanced tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry UI macro</td>
<td>UI macro that displays a customized message to users when they access the initial Password Reset screen.</td>
</tr>
<tr>
<td>Success UI macro</td>
<td>UI macro that displays a customized message to users on the final Password Reset screen when their password is successfully reset.</td>
</tr>
<tr>
<td>Failure UI macro</td>
<td>UI macro that displays a customized message to users on the final Password Reset screen when their password reset fails.</td>
</tr>
<tr>
<td>Post reset script</td>
<td>Script include that performs actions after the Password Reset process completes whether the outcome is success or failure. For more information on customizing post processor scripts, see the <strong>Post reset</strong> script category as described in Password Reset extension script categories.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Header UI macro / Footer UI macro</td>
<td>Macros that add a header or footer to customize the appearance of the pages that end users work in while resetting a password (the Identify, Verify, and Reset pages. See Add a custom header or footer to the user pages for Password Reset.</td>
</tr>
</tbody>
</table>

**Customizing Password Reset processes**

Password Reset scripts enable you to customize Password Reset by creating your own credential store, verification, and identification types, and extend them by defining extension scripts. You can also create a custom credential store type, custom verification type, or verification.

**Legacy**

Password Reset scripting is available to users with the password_reset_admin role. The easiest way to customize Password Reset is:

1. Create custom types and scripts as described in Password Reset extension script categories.

   Extension scripts are example script includes that enable you to extend functionality in a password reset process. The extension script category refers to the specific types of behavior for an extension script (for example, credential store, verification, identification type, or as a post-processor).

2. Follow the configuration steps described in Configure your Password Reset process.
3. Select the new types that you created. You can customize the following components:
   - Credential store types: Define new types for how to connect to your credential stores by creating custom workflows for connection and testing. See Create a credential store type for Password Reset.
   - Verification types: Define new types for how users are verified. See Create a custom Password Reset verification type.
   - Identification types: Define new types for how users can identify themselves. See Create a custom identification type for Password Reset.

Advanced password reset configuration

You can customize the Password Reset and Password Change applications to meet your organization's needs. See Password Reset and Password Change applications for more information. Also see Configure Password Reset properties for a list of properties that control several aspects of password reset.

Customize password reset processes and integrate third-party credential services

To customize password reset processes or to integrate them with third-party credential services such as Okta or Microsoft Azure AD, you use IntegrationHub capabilities. You use Action Designer to create or modify actions like user unlock, change password, and get user status. You use Flow Designer to create or modify subflows that perform the actions.

Role required: admin, password_reset_admin, or password_reset_credential_manager
   - The base system provides actions, subflows, and credential store types for the "Local ServiceNow Instance" identity provider.
   - For Microsoft Active Directory, the subflows are available when you activate the Password Reset - Orchestration Add-on plugin.
   - To use any other identity provider such as Okta or Microsoft Azure AD, you must use IntegrationHub to create the required actions, subflows, and custom credential store types.

1. Use Action Designer to create password reset actions like user unlock, change password, and get user status. See Action Designer for more information.
2. Use Flow Designer to create the following subflows. Use the specified names, inputs, and outputs for the subflows. See Subflows for more information.

<table>
<thead>
<tr>
<th>Subflow name</th>
<th>Input</th>
<th>Input type</th>
<th>Output</th>
<th>Output type</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;Provider Name&gt;</code></td>
<td>Password Reset Request</td>
<td>Record.Password Reset Request</td>
<td>Error Message</td>
<td>String</td>
</tr>
<tr>
<td><code>&lt;Provider Name&gt;</code></td>
<td>Password</td>
<td>Password (2 Way Encrypted)</td>
<td>Status</td>
<td>Choice</td>
</tr>
<tr>
<td><code>&lt;Provider Name&gt;</code></td>
<td>Password Reset Request</td>
<td>Record.Password Reset Request</td>
<td>Error Message</td>
<td>String</td>
</tr>
<tr>
<td>Subflow name</td>
<td>Input</td>
<td>Input type</td>
<td>Output</td>
<td>Output type</td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
<td>------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Current Password</td>
<td>Password</td>
<td>Password (2 Way Encrypted)</td>
<td>Error Message</td>
<td>String</td>
</tr>
</tbody>
</table>

**Note:**
Name under Advanced options is `old_password`.

<table>
<thead>
<tr>
<th>New Password</th>
<th>Password</th>
<th>Password (2 Way Encrypted)</th>
<th></th>
</tr>
</thead>
</table>

**Note:**
Name under Advanced options is `new_password`.

<table>
<thead>
<tr>
<th>&lt;Provider Name&gt; Password Lock Request</th>
<th>Password Reset Request</th>
<th>Record.Password Reset Request</th>
<th>Error Message</th>
<th>String</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Status</th>
<th>Choice</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Status</th>
<th>Choice</th>
</tr>
</thead>
</table>

3. For third party providers, create a credential store type.
   a) Select the **Use Flow** check box.
   b) Select the password reset subflows that you created for the provider.

   See Password Reset application for more information.

4. Create password reset credential store. Select the credential store type created for the provider.

5. Create a password reset process. Select the credential store created for the provider.

The password reset mechanism for the required third-party application is set up.

**Add a custom question to the Security Questions verification**

To enroll for the ‘Security Questions’ verification, the user selects several questions and supplies confidential answers that only the user knows. You can add a custom question to the set of questions that are included with the base system.

Role required: password_reset_admin or admin

The base system provides a large set of default questions in all supported languages. Questions are presented to each user in the language that the user requested during login. Creating a custom English language question is a one-step process. To create a custom question in a non-English language, you can use either of the following options:

- Create a custom question in the non-English language.
- Create a custom English language question plus one or more translations of the question into other languages.

1. Navigate to **Password Reset > Security Questions**.

   **Note:** Each question in the list is presented to users when they enroll for the Password Reset process. The user selects each question to use by providing a confidential answer to the question.

2. Follow this procedure to create a custom question in a single language.

   **Note:** To enter non-English question text, you must request the language when logging in.

   a) On the Password Reset Questions page, click **New**.
   b) Enter the text in the **Question (Translated field)** field and then click **Submit**.

   The question is added to the list of questions that is presented to users when they enroll. No additional steps are needed and you can skip the remaining steps.

3. Follow this procedure to create a custom question in English and the same question in one or more other languages:
   a) Click **New**, enter English language text in the **Question (Translated field)** field, and then click **Submit**.
   b) Create a record in the **sys_translated** table for the non-English language question. Details appear at #unique_2434 and #unique_2435.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label (translate)</td>
<td>Non-English equivalent of the English text in the <strong>Value</strong> field.</td>
</tr>
<tr>
<td>Element</td>
<td>Name of the field in the Password Reset Question [pwd_question] table: <strong>question_translated</strong></td>
</tr>
<tr>
<td>ID</td>
<td>ISO 639.2 code for the language.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that you are adding the translated question to: the Password Reset Question [pwd_question] table.</td>
</tr>
<tr>
<td>Language</td>
<td>Language code for this translated text.</td>
</tr>
<tr>
<td>Value</td>
<td>English-language question that you added in the Security Questions table.</td>
</tr>
</tbody>
</table>

c) Repeat the process for each language that users might request.

**Add a custom header or footer to the user pages for Password Reset**

You can specify UI macros that add a header or footer to the pages that end users work in while resetting a password (the Identify, Verify, and Reset pages).

Role required: password_reset_admin
1. Configure a UI macro for the header or footer: Navigate to **System UI > UI Macros**, click **New**, and then enter a meaningful **Name** and **Description**.
2. In the XML text box, enter the macro text. The example macro adds the text "Trust Acme to Deliver!" to the footer of the page that users work in while resetting a password.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the reset pages are Public Access</td>
<td>On the Password Reset Details tab, click the Public URL.</td>
</tr>
<tr>
<td>If the reset pages are not Public Access</td>
<td>Log in as an end user and request password reset.</td>
</tr>
</tbody>
</table>

Create a Password Reset verification from an existing verification

The Password Reset application includes several example verifications that you can use as they are or as the basis for a custom verification. If the verification types in the base system do not meet your needs, you can create a custom verification type.
Role required: password_reset_admin

**Note:** The Password Reset Windows Application does not support custom verifications.

1. Navigate to Password Reset > Verifications and select a verification.
2. If needed, modify the parameters on the Password Reset Verification Parameters tab. The parameters are described in the instructions for the type of verification that you are working on.
3. Click Submit.
4. Each verification type has properties that control the user experience. Review the property settings and update as needed.

### Create a custom Password Reset verification type

Each verification in Password Reset is based on the settings for a verification type. If the verification types in the base system do not meet your needs, you can create a custom verification type.

Role required: password_reset_admin or admin

Review the verification types that are provided in the base system to determine whether to create a custom verification type. Then review the verification type components to develop.

1. Navigate to Password Reset > Extensions > Verification Types.
2. Click New, enter a unique and meaningful Name and Description, and then fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment check</td>
<td>Script that determines whether a user is enrolled for verification. Automatic enrollment requires an enrollment check. If no script is specified when <strong>Automatic Enrollment</strong> is selected, a default script is provided.</td>
</tr>
<tr>
<td>Automatic enrollment</td>
<td>Select the check box to auto-enroll users. If <strong>Automatic enrollment</strong> is not selected, then you must provide an enrollment UI macro and enrollment processor script.</td>
</tr>
<tr>
<td>Enrollment UI</td>
<td>Enrollment UI macro that provides the UI for the enrollment.</td>
</tr>
<tr>
<td>Enrollment processor</td>
<td>Enrollment processor script that processes the enrollment.</td>
</tr>
<tr>
<td>Verification UI</td>
<td>Verification UI macro that provides the UI for the verification.</td>
</tr>
<tr>
<td>Verification processor</td>
<td>Verification processor script (extension scripts) that processes the verification.</td>
</tr>
</tbody>
</table>

3. Click Submit.

### Create a custom Password Reset verification

Use a verification type in the base system as a template to design a custom verification. The Password Reset Windows Application does not support custom verifications.

Role required: password_reset_admin
### Verification types in the base system

<table>
<thead>
<tr>
<th>Verification type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal Data Confirmation</td>
<td>Verifies user identity using data from the User [sys_user] table. The user data is displayed to a service desk agent. The agent verifies the data. Enrollment is not required for this type. Recommended for service desk-assisted processes.</td>
</tr>
</tbody>
</table>

*Note:* The Password Reset Windows Application does not support the Personal Data Confirmation Verification type.

See [Personal data identification types and confirmation type verifications](#).

<table>
<thead>
<tr>
<th>Personal Data</th>
<th>Verifies user identity using data from the User [sys_user] table. The user is required to answer questions. Enrollment is not required for this type.</th>
</tr>
</thead>
</table>

*Note:* The Password Reset Windows Application allows you to define and use multiple verifications of the Personal Data type.

See [Personal data identification types and confirmation type verifications](#).

<table>
<thead>
<tr>
<th>Email Code</th>
<th>When a user requests password reset, the system sends a verification code to the email address in the user profile or to an email address that the user authorized during enrollment. To verify identity, the user then submits the code on the Password Reset Verify page.</th>
</tr>
</thead>
</table>

*Note:* The Password Reset Windows Application allows you to define and use multiple verifications of the Email Code type.

See [Personal data identification types and confirmation type verifications](#).

<table>
<thead>
<tr>
<th>Google Authenticator</th>
<th>While requesting password reset, the user reads a code from the Google Authenticator app on a device that the user has paired. To verify identity, the user then submits the code on the Password Reset Verify page.</th>
</tr>
</thead>
</table>

*Note:* The Password Reset and Password Reset Windows Application support only a single verification of the SMS Code type.

<table>
<thead>
<tr>
<th>Security Questions</th>
<th>Verifies user identity by presenting personal security questions that the user must answer correctly.</th>
</tr>
</thead>
</table>

*Note:* The Password Reset and Password Reset Windows Application support only a single verification of the Security Questions type.

See [Add a custom question to the Security Questions verification](#).
<table>
<thead>
<tr>
<th>Verification type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMS Code</td>
<td>When a user requests password reset, the system sends a code to an SMS-capable device that the user has authorized. To verify identity, the user then enters the code on the Password Reset web page.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Password Reset and Password Reset Windows Application support only a single verification of the SMS Code type.</td>
</tr>
<tr>
<td></td>
<td>See SMS Code Verification type for Password Reset.</td>
</tr>
<tr>
<td>Mock</td>
<td>Not a functional identity verification. Demonstrates how to add a verification type in a Password Reset process.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Password Reset Windows Application does not support the Mock verification type.</td>
</tr>
<tr>
<td></td>
<td>• The enrollment UI macro for this verification gets the user input and returns the entered value in the enrollment processor.</td>
</tr>
<tr>
<td></td>
<td>• The Password Reset UI macro for this verification gets input from the user and returns the entered value through the verification processor.</td>
</tr>
</tbody>
</table>

1. Navigate to **Password Reset** > **Extensions** > **Verification Types**.
2. Click **New**, enter a unique and meaningful **Name** and **Description**, and then fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Create verifications based on one of the verification types in the base system.</td>
</tr>
<tr>
<td></td>
<td>Password Reset supports the following types. You can create multiple instances of any type.</td>
</tr>
<tr>
<td></td>
<td>• Personal Data Confirmation Verification</td>
</tr>
<tr>
<td></td>
<td>• Personal Data Verification</td>
</tr>
<tr>
<td></td>
<td>• Security Question Verification</td>
</tr>
<tr>
<td></td>
<td>• SMS Code Verification</td>
</tr>
<tr>
<td></td>
<td>The Password Reset Windows Application supports the following types:</td>
</tr>
<tr>
<td></td>
<td>• Personal Data Verification. You can create only a single instance.</td>
</tr>
<tr>
<td></td>
<td>• Security Question Verification. You can create multiple instances.</td>
</tr>
<tr>
<td></td>
<td>• SMS Code Verification. You can create only a single instance.</td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td>Position of the verification as it appears on the Enrollment form and Password Reset form.</td>
</tr>
<tr>
<td><strong>Password Reset</strong></td>
<td>Parameters used by a verification to configure specific behaviors, like number of questions required to enroll, request expiration time, and columns used.</td>
</tr>
<tr>
<td>Verification Parameters</td>
<td>Set parameters for any behavior that should be different from the value that is specified in the Password Reset properties.</td>
</tr>
<tr>
<td></td>
<td>The available parameters are described separately for each verification type.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
4. Each verification type has properties that control the user experience. Review the property settings and update as needed.
Create a custom identification type for Password Reset

A custom identification type enables the user to enter alternative verification information such as an employee ID while resetting the password.

Role required: password_reset_admin or admin

1. Navigate to Password Reset > Extensions > Identification Types.
2. Click New, enter a unique and meaningful Name and Description, and then fill in the form.

<table>
<thead>
<tr>
<th>Identification field label</th>
<th>Text to display as a label for the Identification field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identification processor</td>
<td>Identification processor script. Choose an existing script or create your own using the Identification form processor category (extension script).</td>
</tr>
</tbody>
</table>

3. Click Submit.

Create a credential store type for Password Reset

You can create a custom credential store type if the base-system types do not meet your needs.

Role required: password_reset_admin or password_reset_credential_manager

1. Navigate to Password Reset > Extensions > Credential Store Types.
2. Click New, enter a unique and meaningful Name and Description.
3. To use password reset subflows in IntegrationHub, leave the Use Flow selected. Select the subflows created for the third-party application.

Note: See Customize password reset processes and integrate third-party credential services for information on creating provider-specific subflows.

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlock user flow</td>
<td>Defines process to unlock a user.</td>
</tr>
<tr>
<td>Password reset flow</td>
<td>Unlocks the specified user account. Expires the current password and changes the password to the provided new password if it conforms to the password format and history policies.</td>
</tr>
<tr>
<td>Password change flow</td>
<td>Changes the password of an authenticated and unlocked user account to the provided new password. Verifies the new password conforms to the password format and history policies. Displays an error if the user is not authenticated or is locked out. Use the Password Reset flow to unlock a locked user account and require a password change.</td>
</tr>
<tr>
<td>Get user lock state flow</td>
<td>Retrieves the lock status of a local ServiceNow user account.</td>
</tr>
<tr>
<td>Connection test flow</td>
<td>Defines how to test the connection.</td>
</tr>
</tbody>
</table>
4. To use the password reset workflows in Orchestration, clear the **Use Flow** check box.

   **Note:** You may need to configure the form to see the **Get user lock state** workflow and the **Unlock user** workflow.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset workflow</td>
<td>Subflow that defines the credential store processing. Password Reset workflows are available to use as a model. Provide scripts for each of the activities defined for the subflow. For more information about how to create a workflow, see Create a workflow. For installed workflows, see Installed with Password Reset.</td>
</tr>
<tr>
<td>Connection test workflow</td>
<td>Subflow that defines how to test the connection. Connection test workflows are available to use as a model. If you create a connection test subflow, provide scripts for each of the activities defined for the subflow. For installed workflows, see Installed with Password Reset.</td>
</tr>
<tr>
<td>Get user lock state workflow</td>
<td>Subflow that defines how to get the user lock state. Get user lock state workflows are available to use as a model. Provide scripts for each of the activities defined for the subflow. For more on how to create a workflow, see Create a workflow. For installed workflows, see Installed with Password Reset.</td>
</tr>
<tr>
<td>Unlock user workflow</td>
<td>Subflow that defines how to unlock a user. Unlock user workflows are available to use as a model. If you create a connection test subflow, provide scripts for each of the activities defined for the subflow. For installed workflows, see Installed with Password Reset.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Password Reset script includes**

The Password Reset plugin installs script includes that implement password reset processes. To enable you to extend functionality, each base-system script include provides extension points that you can use to invoke "extension scripts" that you customized.

The **extension script category** refers to the specific types of behavior for an extension script (for example, credential store, verification, identification type, or as a post-processor).

**'Enrollment check' script includes**

All enrollment check script includes take the following parameters and return a boolean indicating whether the user is enrolled for Password Reset.

- `params.userId`: The sys_id of the user being checked (table: [sys_user]).
- `params.verificationId`: The sys_id of the verification being checked (table: [pwd_verification]).
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdAlwaysEnrolled</td>
<td>Default check of whether a user is enrolled that always returns true.</td>
</tr>
<tr>
<td>PwdMockIsEnrolled</td>
<td>Default check of whether a user is enrolled that always returns true.</td>
</tr>
<tr>
<td>PwdQuestionsEnrollmentCheck</td>
<td>Determines whether a user has enrolled for Password Reset using security question verification.</td>
</tr>
<tr>
<td>PwdSMSEnrollmentCheck</td>
<td>Determines whether a user has enrolled for Password Reset using SMS verification.</td>
</tr>
</tbody>
</table>

**Identification form processor’ script includes**

Identification form processor script includes provide functionality for extending identification processing.

All identification form processor script includes take the following parameters, and return the sys_id of the user that corresponds to the requested input. If the user was not identified, it returns null.

- `params.processId`: The sys_id of the calling Password Reset process (table: [pwd_process]).
- `param request`: The form request object. Fields in the form can be accessed with `request.getParameter('<element-id>')`. The supported request parameter is `sysparm_user_id`, the user identifier value entered in the form.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdIdentifyViaEmail</td>
<td>Verifies a user’s identity by checking the email address.</td>
</tr>
<tr>
<td>PwdIdentifyViaUsername</td>
<td>Verifies a user’s identity by checking the user name.</td>
</tr>
</tbody>
</table>

**Enrollment form processor’ script includes**

Enrollment form processor script includes provide functionality for extending enrollment form processing.

All enrollment form processor script includes take the following parameters, and return a boolean indicating whether the user was successfully enrolled.

- `params.userId`: The sys_id of the user trying to enroll (table: [sys_user]).
- `params.verificationId`: The sys_id of the verification used to enroll (table: [pwd_verification]).
- `params.enrollmentId`: The sys_id of this enrollment process.
- `request`: The form request object. Fields in the form can be accessed with `request.getParameter('<element-id>')`.

You should add the following information to the state of the enrollment process:

- `gs.getSession().putProperty("result.status",status)`: Whether the user was successfully enrolled.
- `gs.getSession().putProperty("result.message",message)`: An associated message to be returned to the UI, such as a detailed error message.
- `gs.getSession().putProperty("result.value",value)`: A custom value associated with the enrollment.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdEnrollQuestionsProcessor</td>
<td>Handles questions and answers for verification.</td>
</tr>
<tr>
<td>PwdEnrollSampleProcessor</td>
<td>Provides an enrollment processor for sample verification.</td>
</tr>
<tr>
<td>PwdEnrollSMSProcessor</td>
<td>Provides an enrollment processor for SMS verification.</td>
</tr>
</tbody>
</table>

**'User account lookup' script includes**

User account lookup script includes return the credential store account_id for a given user. The following parameter returns the credential store account_id for a given user.

- `params.userId`: The sys_id of the user being checked (table: [sys_user]).

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdDefaultUserAccountLookup</td>
<td>Provides a default script for user account lookup from a user_id to the account in a credential store. The default mapping is to use the user name as the account name.</td>
</tr>
</tbody>
</table>

**'Password generator' script includes**

Password generator script includes take the following parameter, and return an auto-generated string password.

- `params.credentialStoreId`: The sys_id of the calling Password Reset process (table: [pwd_process]).

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdDefaultAutoGenPassword</td>
<td>Generates a password from a random word and 4 digits.</td>
</tr>
</tbody>
</table>

**'Verification processor' script includes**

If the user identity is verified, the verification processor script includes return `true`. Verification processor script includes take the following parameters:

- `params.resetRequestId`: The sys_id of the current Password Reset request (table: [pwd_reset_request]).
- `params.userId`: The sys_id of the user to be verified (table: [sys_user]).
- `params.verificationId`: The sys_id of the verification (table: [pwd_verification]).
- `request`: The form request object. Access the fields in the form with `request.getParameter('<element-id>')`. 
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdVerifyPersonalDataConfirmationProcess</td>
<td>Verifies that the user accepts the answer.</td>
</tr>
<tr>
<td>PwdVerifyPersonalDataProcessor</td>
<td>Verifies that the user's answers match the expected data in the system.</td>
</tr>
<tr>
<td>PwdVerifyQuestionsProcessor</td>
<td>Provides question and answer verification of user input on the second page of the verification form.</td>
</tr>
<tr>
<td>PwdVerifySimpleProcessor</td>
<td>Provides simple verification of user input on the second page of the verification form.</td>
</tr>
<tr>
<td>PwdVerifySMSProcessor</td>
<td>Provides SMS verification of user input on the second page of the verification form.</td>
</tr>
</tbody>
</table>

**'Post processor' script includes**

Post processor script includes execute custom actions after the Password Reset process has completed.

All post processor script includes take the following parameters.

- `params.resetRequestId`: The sys_id of the current Password Reset request (table: [pwd_reset_request]).
- `params.wfSuccess`: A flag indicating whether the workflow completed successfully: True if, and only if, successful.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdPostProcessor</td>
<td>Executes actions after the process completes for success, failure, or both conditions.</td>
</tr>
</tbody>
</table>

**Example custom scripts for Password Reset**

The example scripts perform a user account lookup and processes an identification form, define a credential store, and create an identification type.

**Perform a user account lookup and process an identification form**

The main script calls two extension scripts, one to perform the user account lookup, and the other to process the identification form.

```javascript
// User account lookup
var lookupExtensionSysId = 
  getExtensionScriptSysId('SampleUserAccountLookupExtension', 'user_account_lookup');
var lookupExtension = new SNC.PwdExtensionPoint(lookupExtensionSysId);

// Setup parameters required for this extension type - userId
var params = new SNC.PwdExtensionPointParameter();
params.userId = 'joe.employee';

// Invoke the extension
var answer = lookupExtension.process(params);
gs.print('user: ' + answer);

// Form processor sample - Identification form processor
```
Define a credential store

The following is an example of an extended process function in the User Account Lookup category used to define a credential store. To create this extension script, go to Password Reset > Extensions > New extension script and create a new script as described in Create an Extension Script. To configure the User Lookup in a Password Reset process, see Credential Stores.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<record_update table="sys_script_include">
  <sys_script_include action="INSERT_OR_UPDATE">
    <active>true</active>
    <client_callable>false</client_callable>
    <description>Simple account lookup that returns the supplied user id</description>
    <name>SampleUserAccountLookupExtension</name>
    <script><![CDATA[SampleUserAccountLookupExtension = Class.create();
SampleUserAccountLookupExtension.prototype = {
  category: 'password_reset.extension.user_account_lookup', // DO NOT REMOVE THIS LINE!
  execute: function(userId) {
    return sys_user.findOne({sys_id: userId});
  }
};]]></script>
</sys_script_include>
</record_update>
```
Create an identification type

The following is an example of an extended processForm function in the Identification Form Processor category that can be used to create an identification type. To create this extension script, go to Password Reset > Extensions > New extension script and create a new script as described in Create an Extension Script.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<record_update table="sys_script_include">
  <sys_script_include action="INSERT_OR_UPDATE">
    <active>true</active>
    <client_callable>false</client_callable>
    <description>Script that processes an identification form. Returns the sys-id of the user that corresponds to the requested input; if no user was found, null should be returned.</description>
    <name>SampleIdentificationProcessorExtension</name>
    <script><![CDATA[var SampleIdentificationProcessorExtension = Class.create();]]></script>
  </sys_script_include>
</record_update>
```
SampleIdentificationProcessorExtension.prototype = {
  category: 'password_reset.extension.identification_form_processor', // DO NOT REMOVE THIS LINE!

  /*********************************************************************
   * Process the identification form request, and returns the user's sys_id. if user was not identified return null.
   * @param params.processId The sys-id of the calling password-reset process (table: pwd_process)
   * @param request The form request object. fields in the form can be accessed using: request.getParameter('<element-id>')
   * Supported request parameters:
   * sysparm_user_id - the user identifier value entered in the form.
   * @return The sys-id of the user that corresponds to the requested input; if no user was found, null should be returned.
   *********************************************************************/
  processForm: function(params, request) {
    return request.getParameter('sysparm_user_id') + '_' + params.processId;
  },

  type: 'SampleIdentificationProcessorExtension'
};
ServiceNow

DocVersion

Now Platform capabilities

Use the process and processForm extensions
This example shows a script that uses two sample extensions, one process extension and one
processForm extension.
// User account lookup var lookupExtensionSysId =
getExtensionScriptSysId('SampleUserAccountLookupExtension','user_account_lookup');var
lookupExtension =new SNC.PwdExtensionPoint(lookupExtensionSysId);
// Setup parameters required for this extension type - userIdvar params =new
SNC.PwdExtensionPointParameter();
params.userId='joe.employee';
// Invoke the extension var answer = lookupExtension.process(params);
gs.print('user: '+ answer);

//Form processor sample - Identification form processorvar
identExtensionSysId =
getExtensionScriptSysId('SampleIdentificationProcessorExtension','identification_form_p
identificationExtension =new SNC.PwdExtensionPoint(identExtensionSysId);
// Setup parameters required for this extension type - processIdvar params
=new SNC.PwdExtensionPointParameter();
params.processId='pwdreq1234';
// Simulate the posted form parameter for the indentification processorvar
request =new SNC.PwdExtensionPointParameter();// A real life case will
inject it's own request object
request.setParameter('sysparm_user_id','joe.employee');
var userIdentity = identificationExtension.processForm(params, request);
gs.print('identity: '+ userIdentity);
// Simple helper to return the sys-id for a given extension scriptfunction
getExtensionScriptSysId(scriptName, category){var result;var now_GR =new
GlideRecord('sys_script_include');
gr.addQuery('name', scriptName);
gr.addQuery('script','CONTAINS','category: \'password_reset.extension.'+
category +'\'');
gr.query();
if(gr.next()){
result = gr.getValue('sys_id');}return result;}
process function:
<?xml version="1.0" encoding="UTF-8"?><record_update
table="sys_script_include"><sys_script_include
action="INSERT_OR_UPDATE"><active>true</active><client_callable>false</
client_callable><description>Simple account lookup that returns the
supplied user id</description><name>SampleUserAccountLookupExtension</
name><script><![CDATA[var SampleUserAccountLookupExtension =Class.create();
SampleUserAccountLookupExtension.prototype={
category:'password_reset.extension.user_account_lookup',// DO NOT REMOVE
THIS LINE!
/**********
* Returns the credential-store account id for a given user
*
* @param params.userId The sys-id of the user being checked (table:
sys_user)
©

2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States
and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2867


processForm function:

```xml
<?xml version="1.0" encoding="UTF-8"?><record_update
table="sys_script_include"><sys_script_include
action="INSERT_OR_UPDATE">active"true</active><client_callable"false"/
description"Script that processes an identification
form.";#13;
Returns the sys-id of the user that corresponds to the requested
input; if no user was found, null should be returned."#13;/
description"name"SampleIdentificationProcessorExtension"name"><script>!
[CDATA[ var SampleIdentificationProcessorExtension = Class.create();
SampleIdentificationProcessorExtension.prototype={
category:'password_reset.extension.identification_form_processor', // DO
NOT REMOVE THIS LINE!

***************/
* Process the identification form request, and returns the user's sys_id.
if user was not identified return null.
* 
* @param params.processId The sys-id of the calling password-reset
process (table: pwd_process)
* @param request The form request object. fields in the form
can be accessed using: request.getParameter('<element-id>')
* 
* Supported request paramters:
*  sysparm_user_id - the user identifier

value entered in the form.
* @return The sys-id of the user that corresponds to the requested input;
if no user was found, null should be returned.

***********/
processForm:function(params, request)(return
request.getParameter('sysparm_user_id')+'_'+ params.processId);,
```
Password Reset extension script categories

You can use a custom extension script to extend Password Reset functionality for credential store, verification, or identification types.

**Note:** To use a script include as an extension script, you must set it to **Active** status.

### Password Reset extension script categories

Extension scripts must specify a category that indicates which script include is being extended, for example, category: `password_reset.extension.enrollment_check`. The ServiceNow platform installs several scripts in each category. A script in the **Enrollment check** category can perform the enrollment check for a verification. Detailed information on each extension script appears in Password Reset extension scripts.

<table>
<thead>
<tr>
<th>Extension script category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment check</td>
<td>Defines how to check that a user is enrolled in the Password Reset process. Scripts of this category are available in the <strong>Enrollment check</strong> field when you define a verification type (Password Reset Verification Type form).</td>
</tr>
<tr>
<td>Enrollment form processor</td>
<td>Defines how an enrollment form is processed (if automatic enrollment is not configured). Scripts of this category are available in the <strong>Enrollment form processor</strong> field when you define a verification type (Password Reset Verification Type form).</td>
</tr>
<tr>
<td>Identification form processor</td>
<td>Defines how a user identification is processed. Scripts of this category are available in the <strong>Identification processor</strong> field when you define a verification type (Password Reset Identification Type form).</td>
</tr>
<tr>
<td>Extension script category</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password generator</td>
<td>Defines how to generate a password. Scripts of this category are available in the Auto generate password field when you configure a credential store (Password Reset Credential Store Type form).</td>
</tr>
<tr>
<td>Post reset script</td>
<td>Executes at the end of a Password Reset process. Scripts of this category are available in the Post reset script field when you configure a process (Password Reset Process form).</td>
</tr>
<tr>
<td>User account lookup</td>
<td>Defines how to look up a user account. Scripts of this category are available in the User account lookup field when you configure a credential store (Password Reset Credential Store form).</td>
</tr>
<tr>
<td>Verification form processor</td>
<td>Defines how a verification form is processed. Scripts of this category are available in the Verification processor field when you define a verification type (Password Reset Verification Type form).</td>
</tr>
</tbody>
</table>

**Password Reset extension scripts**

Extension scripts allow you to extend Password Reset functionality in credential store, verification, or identification types.

**Password Reset extension script includes**

Each script include is associated with a specific category, which is available in the appropriate field of a Password Reset form.

**Note:** Create extension scripts only from the Password Reset Extension Script form (Password Reset > Extensions > New extension script). Extension scripts are special purpose script includes that are not created in the System Definition > Script Includes interface. To use a script include as an extension script, you must set it to Active status.

**'Enrollment Check' script include category**

<table>
<thead>
<tr>
<th>Script include category</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment Check</td>
<td>Checks whether a user is enrolled for a given verification.</td>
<td>process(params)</td>
<td>Parameters:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• params.userId</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- The sys_id of</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>the user to check</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(table: sys_user).</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• params.verificationId</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- The sys_id of</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>the verification</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>to check (table:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>pwd_verification).</td>
<td></td>
</tr>
</tbody>
</table>

Returns: (boolean) true, if the user is enrolled in the specified verification; otherwise, false.
This Enrollment Check example signals that the user is enrolled if both expected parameters are supplied. The code would be contained in the Script field of an extension script named SampleEnrollmentCheck:

```javascript
var SampleEnrollmentCheck = Class.create();
SampleEnrollmentCheck.prototype = {
    category: 'password_reset.extension.enrollment_check', // DO NOT REMOVE THIS LINE!

    process: function(params) {
        return (params.userId && params.verificationId) ? true : false;
    },

type: 'SampleEnrollmentCheck'
};
```
### 'Enrollment Form Processor' script include category

<table>
<thead>
<tr>
<th>Script include category</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment Form Processor</td>
<td>Checks whether all necessary information has been collected from the user. Stores the information so it can be used for verification when the user resets their password.</td>
<td>process(params)</td>
<td>Parameters:</td>
<td>Returns: (boolean)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>true, if the user is enrolled in the specified verification; otherwise, false.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• params.resetRequestId</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- The sys_id of the current Password Reset request (table: pwd_reset_request).</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• params.userId</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- The sys_id of the user to be verified (table: sys_user).</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• params.verificationId</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- The sys_id of the verification to be processed (table: pwd_verification).</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• request</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- The form request object. Fields in the form can be accessed with request.getParameter('&lt;element-id&gt;').</td>
<td></td>
</tr>
</tbody>
</table>

The following information should be added to the state of the enrollment process:

- gs.getSession().putProperty("result.status", status) - Whether the user was successfully enrolled.
- gs.getSession().putProperty("result.message", message) - An associated message to be returned to the UI, such as a detailed error message.
- gs.getSession().putProperty("result.value", value) - A custom value associated with the enrollment.
This example processes an enrollment form submission successfully if the user-submitted response was success. The code would be contained in the `Script` field of an extension script named `SampleEnrollmentProcessor`:

```javascript
var SampleEnrollmentProcessor = Class.create();
SampleEnrollmentProcessor.prototype = {
  category: 'password_reset.extension.enrollment_form_processor', // DO NOT REMOVE THIS LINE!

  processForm: function(params, request) {
    var verificationId = params.verificationId;
    var sampleInput = request.getParameter('sample_input');
    if (now_GR.nil(verificationId) || (sampleInput != 'success')) {
      return false;
    }

    var now_GR = new GlideRecord('sys_user');
    now_GR.get(params.userId);
    now_GR.print('User: ' + now_GR.getValue('user_name') + ' successfully enrolled');
    return true;
  }
};
```

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
'Identification Form Processor' script include category

<table>
<thead>
<tr>
<th>Script include category</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identification Form Processor</td>
<td>Processes an identification form request.</td>
<td>processForm(params, request)</td>
<td>Parameters:</td>
<td>Returns: the sys_id of the user that corresponds to the requested input. Returns null, if no user was found.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• params.processId - The sys_id of the calling Password Reset process (table: pwd_process).</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• request - The form request object. Fields in the form can be accessed with request.getParameter('&lt;element-id&gt;'). Use request.getParameter('sysparm_user_id') to get the user ID that was entered into the form.</td>
<td></td>
</tr>
</tbody>
</table>

This example attempts to identify the user within the sys_user table given a user name submitted from the identification form. The code would be contained in the Script field of an extension script named PwdIdentifyViaUsername:

```javascript
var PwdIdentifyViaUsername = Class.create();
PwdIdentifyViaUsername.prototype = {
  category: 'password_reset.extension.identification_form_processor', // DO NOT REMOVE THIS LINE!
  initialize: function () {},

  //**********
  // * Process the identification form request, and returns the user's sys_id. If user was not identified return null.
  // *
  // * @param params.processId The sys_id of the calling Password Reset process (table: pwd_process)
  // * @param request The form request object. Fields in the form can be accessed with
  // * request.getParameter('<element-id>')
  // * Supported request parameters: sysparm_user_id - the user identifier value entered in the form
  // * @return The sys_id of the user that corresponds to the requested input;
  // * if no user was found, null should be returned
  //**********/
  processForm: function (params, request) {
    var processId = params.processId;
    var sysparm_user_id = request.getParameter('sysparm_user_id');
    now_GR = new GlideRecord('sys_user');
    now_GR.addQuery('user_name', sysparm_user_id);
    now_GR.query();
    if (!now_GR.next()) {
      return null;
    } return now_GR.sys_id;
  }
};
```

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
'Password Generator' script include category

<table>
<thead>
<tr>
<th>Script include category</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Generator</td>
<td>Returns an auto-generated password.</td>
<td>process(params)</td>
<td>Parameters:</td>
<td>Returns: (String) an auto-generated password.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• params.processId</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- The sys_id of the calling Password Reset process (table: pwd_process).</td>
<td></td>
</tr>
</tbody>
</table>

This example randomly generates a password from a base word and numbers. The base word is selected depending on the credential store. The code would be contained in the Script field of an extension script named SamplePasswordGenerator:

```javascript
var SamplePasswordGenerator = Class. create();
SamplePasswordGenerator.prototype = {
  category : 'password_reset.extension.password_generator', // DO NOT REMOVE THIS LINE!
  process : function (params ) { var basePassword ;
    var now_GR  = new GlideRecord ( 'pwd_cred_store' ) ;
    now_GR. addQuery ( 'name' , 'Local ServiceNow Instance' ) ;
    now_GR. query ( ) ; if (now_GR. next ( ) ) { if (params. credentialStoreId == now_GR. getValue ( 'sys_id' ) ) { basePassword  = "Password" ; } else { basePassword  = "Dorwssap" ; } } return this. generateSimple (basePassword ) ; },
  generateSimple : function (base ) { var pwd  = base ; var numbers  = '0123456789' ; var length  = 4 ;
    for ( var i  = 0 , n  = numbers. length ; i  < length ; i ++ ) { pwd  += numbers. charAt (Math. floor (Math. random ( ) * n ) + 1 ) ; } return pwd ; },
  type : 'SamplePasswordGenerator' }
```
'Post Reset' script include category

<table>
<thead>
<tr>
<th>Script include category</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post Reset</td>
<td>Performs additional operations after the completion of the Password Reset process.</td>
<td>process(params)</td>
<td>Parameters:</td>
<td>Returns: void</td>
</tr>
</tbody>
</table>

- `params.resetRequestId` - The sys_id of the calling Password Reset process (table: pwd_process).
- `params.wfSuccess` - A flag indicating whether the workflow completed successfully. True if, and only if, successful.

This example adds failed reset requests to the system log. The code would be contained in the `Script` field for an extension script named `PwdPostProcessor`:

```javascript
var PwdPostProcessor = Class.create();
PWDPostProcessor.prototype = {
    initialize: function () {
        /*
         * Execute custom actions after the Password Reset process has completed.
         * @param params.resetRequestId The sys_id of the current Password Reset request (table: pwd_reset_request)
         * @param params.wfSuccess A flag indicating if the workflow completed successfully.
         * @return no return value
         */
        process: function (params) {
            if (!params.wfSuccess) {
                now_GR.log('[PwdPostProcessor.process] failure post processing for request [' + params.resetRequestId + ']');
                // We could place actions here that we always want executed
                return;
            }
            // PwdPostProcessor
        },
        type: 'PwdPostProcessor'
    }
};
```

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
'User Account Lookup' script include category

<table>
<thead>
<tr>
<th>Script include category</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Account Lookup</td>
<td>Gets the credential store account ID for a given user.</td>
<td>process(params)</td>
<td>Parameters:</td>
<td>Returns: (String) the credential store account ID for the given user.</td>
</tr>
</tbody>
</table>

This example gets the credential store account for a user. This code would be contained in the Script field of an extension script named `SampleUserAccountLookupExtension`:

```javascript
var SampleUserAccountLookupExtension  = Class. create () ;
SampleUserAccountLookupExtension. prototype = {
    category : 'password_reset.extension.user_account_lookup' , // DO NOT REMOVE THIS LINE!

    process : function (params ) { return params. userId ; }
}
```

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### 'Verification Form Processor' script include category

<table>
<thead>
<tr>
<th>Script include category</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verification Form Processor</td>
<td>Processes a verification form request and indicates whether the user was verified or not.</td>
<td>processForm(params, request)</td>
<td>Parameters: &lt;ul&gt;&lt;li&gt;params.resetRequestId - The sys_id of the current Password Reset request (table: pwd_reset_request).&lt;/li&gt;&lt;li&gt;params.userId - The sys_id of the user to be verified (table: sys_user).&lt;/li&gt;&lt;li&gt;params.verificationId - The sys_id of the verification to be processed (table: pwd_verification).&lt;/li&gt;&lt;li&gt;request - The form request object. Fields in the form can be accessed with request.getParameter('&lt;element-id&gt;').&lt;/li&gt;&lt;/ul&gt;</td>
<td>Returns: (boolean) true, if the user is verified; otherwise, false.</td>
</tr>
</tbody>
</table>

This example shows a verification processor that returns true only if the user sent `ok` in the input field; otherwise, it returns false. The code would be contained in the `Script` field of an extension script named `SampleVerificationFormProcessor`:

```javascript
var SampleVerificationFormProcessor = Class.create();
SampleVerificationFormProcessor.prototype = {
    category : 'password_reset.extension.verification_form_processor', // DO NOT REMOVE THIS LINE!

    processForm: function(params, request) {
        // Implementation of the processForm method
    }
};
```

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Create a Password Reset extension script

Create extension scripts only from the Password Reset Extension Script form. Do not create extension scripts in the System Definition > Script Includes interface.

Role required: password_reset_admin or admin

**Note:** To use a script include as an extension script, you must set it to Active status.

1. Navigate to Password Reset > Extensions > New extension script.
2. Enter a name in the Extension script name field.
   Use CamelCase to construct a name without spaces, for example, PwdEnrollmentCustom.
3. Select an Extension script category.
   - Enrollment check
   - Enrollment form processor
   - Identification form processor
   - Password generator
   - User account lookup
   - Verification form processor
4. Click Submit.
   A new instance of the script include for the selected category opens.
5. Edit the script by providing an implementation in the body of the process or `processForm` function, depending on the script category. You can add additional functions as long as the process or `processForm` function accepts the defined parameters and returns the expected results.

   ![Script Editor](image)

   **Note:** Do not edit or delete the `Category` declaration.

6. Click **Update**.

**Service desk: Reset a password or unlock a user account**

In a service desk-assisted Password Reset process, service desk agents with the `password_reset_service_desk` role reset user passwords when the end users cannot reset passwords by themselves, such as when they’ve forgotten their verification answers.

Role required: `password_reset_admin` or `password_reset_service_desk`

Watch a video example of service desk agents resetting passwords: [Resetting User Passwords (Video)](link).

   ![Video Link](image)

   **Note:**
   - You must clear the **Public access** property to enable the service desk-assisted process. See [Configure your Password Reset process](link).
   - You can perform this activity on a mobile device.

1. Navigate to **Password Reset > Service Desk**.
2. Select a user and the Password Reset process to use.
3. Click Verify Identity.
4. On the Verify Identity form, enter the answers that the user provides and then click Continue. If the user identity is verified, the Reset Password form displays identity verification and status of the account lock.
5. Perform one of the following actions.
   - If the user is not locked, the form displays the Reset password button. Enter the new password and click Reset password.
   - If the user is locked, the form displays the Reset password and Unlock account buttons. You can enter a new password and click Reset password to reset the password and unlock the account. If the Enable account unlock check box is selected for the password process, you can unlock the account without resetting the password by clicking Unlock account.
6. To reset the password for a different user, you must first navigate out of the Service Desk and then navigate to Password Reset > Service Desk.

View user requests for password reset

The Reset Requests module displays the status of each password reset request from the Password Reset Request table [pwd_reset_request].

Role required: password_reset_admin or password_reset_service_desk

Navigate to Password Reset > Reset Requests.

Password Reset request fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>User whose password is being reset or changed.</td>
</tr>
<tr>
<td>Process</td>
<td>Process that implements this password reset request.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of Password Reset request:</td>
</tr>
<tr>
<td></td>
<td>• Change Password: Request to change a password.</td>
</tr>
<tr>
<td></td>
<td>• Help Desk: Request opened on behalf of the requesting user by a service desk agent.</td>
</tr>
<tr>
<td></td>
<td>• Self Service: Requesting user opened the reset request.</td>
</tr>
<tr>
<td>Action Type</td>
<td>Corrective action performed during the Password Reset request.</td>
</tr>
<tr>
<td></td>
<td>• Change Password: Update the credential store with the new password.</td>
</tr>
<tr>
<td></td>
<td>• Reset and Unlock Account: Generate a new password for the user and unlock the user account.</td>
</tr>
<tr>
<td></td>
<td>• Reset Password: Generate a new password for the user.</td>
</tr>
<tr>
<td></td>
<td>• Unlock Account: Unlock the user account.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Result of the Password Reset request:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Completed With Failure</strong>: User completed all steps in the Password Reset process, but the password was not reset in the credential store.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Completed With Success</strong>: User completed all steps in the Password Reset process and the password was reset in the credential store.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Expired</strong>: User did not complete all steps in the Password Reset process in the time allowed.</td>
</tr>
<tr>
<td></td>
<td>- <strong>In Progress</strong>: User is working through the steps to reset the password.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Max Number of Attempts</strong>: User failed to answer the security questions correctly during the identity verification step and has exceeded the maximum number of attempts allowed.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Verified</strong>: User has completed the identity verification step and is verified. The user can move to the Password Reset step.</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the request is open or closed.</td>
</tr>
<tr>
<td>Retry</td>
<td>Total number of times the user has attempted to complete a password reset request.</td>
</tr>
</tbody>
</table>

### Unblock a Password Reset user

If a user is manually banned or is flagged as exceeding max attempts, the user can be blocked (not allowed to use the Password Reset application). You can unblock a blocked user.

Role required: `password_reset_admin` or `password_reset_service_desk`

Blocking events include:

- The user exceeded the limit for the number of failed password attempts.
- The most recent password reset occurred before the wait time required until the next reset.
- The user failed to provide the correct information while attempting to reset the password.

If the number of blocked or locked users exceeds the limit within a defined time interval, it triggers a system log event. You can configure the number of blocked or locked users and the time interval required to generate the log event by setting the `password_reset.activity_monitor.incident_threshold` and `password_reset.activity_monitor.incident_window` properties.

1. To view the list of blocked users, navigate to **Password Reset > Blocked Users**.
2. To unblock a self-service user:
   a) Navigate to **Password Reset > Blocked Users**.
   b) Select a user from the list.
   c) Select **Delete** on the **Actions on selected rows** list.
3. To unblock a user whose password was reset by a service desk agent:
   If a user is manually banned or flagged as exceeding max attempts, the user can be blocked (not
   allowed to use the Password Reset application). When the password reset request is made through
   self-service, the user is unblocked when the password is successfully reset.

   In contrast, service desk agents are allowed any number of retries. The max_attempt_reached limit
   does not apply and the Blocked status for the user is not reset after the password is reset. As a result,
   after you successfully reset a user password, you must unblock the user manually.

   If the user is not unblocked manually, then the system resets the blocked state only when the
   max_attempt_window time period elapses and the user tries to reset the password using self-
   service.

   a) After you successfully reset a user password, navigate to Password Reset > Blocked Users.
   b) Change the Blocked setting for the user from true to false.

Integrate Password Reset with a Service Portal widget

You can enable a Password Reset process in a Service Portal page by adding a widget that opens the
password reset pages inside the portal.

Role required: admin or sp_admin

1. On the Service Portal Designer for the portal, create a new page — the page where the user will
   perform the password reset process.
2. On the Widget tab, under Layouts, select the 12-column layout and drop it onto the page.
3. Drop the Pwd reset widget into the 12-column layout and then save the page.
   The three tabs of the password reset process appear in the layout.
4. In the "Reset my password" link on the login page for the portal, specify the URL of the new password
   reset page. The URL must include one required parameter and may contain one optional parameter:
   • Required: sysparm_show_custom_header_footer=false. This parameter disables the native
     header and footer feature of the password reset page.
   • Optional: sysparm_redirect_url=<portalName>?id=<pageName>. This parameter specifies
     the page to go to after a successful reset — typically the login page for the portal.

   For example, https://server.acme.com/acme_community?id=password_reset_page&
   sysparm_show_custom_header_footer=false&sysparm_redirect_url=acme_community?
   id=communities_login

Integrate Password Reset with a CMS integration

You can configure a site in the ServiceNow content management (CMS) application to define a single-site
access point that includes the Password Reset service. For example, you can create an employee self-
service site that provides Password Reset service.

Role required: content_admin

Each Password Reset process requires a separate CMS page.

1. Navigate to Content Management > Specialty Content > iFrames and create an iFrame record.
2. Go to **Content Management > Sites** and create a site that has no login page.

3. Go to **Content Management > Pages** and create a password reset page.

4. Enter the name of the site that you created in the **Content site** field (**Password Reset self-service** in the example).

5. Right-click the form header and click **Save**.

6. Click the **Edit Page** related link and then click **Add content**.

7. In the **Content Blocks** section, select the iFrame that you created. Add more content as needed.

8. Click **Update**.

**Password Reset and Password Change reports and logs**

The Password Reset application provides several tools for monitoring and troubleshooting password reset activities.

Users with the `password_reset_credential_manager` or `password_reset_admin` role can view the status of password reset activities, identify potential security threats, and monitor for compliance with password security policies.
The **Reset Requests**, **Activity Log**, and **Blocked Users** modules are useful for monitoring password reset activities and for troubleshooting password reset issues. They also provide access to more detailed information than is provided on the Overview module.

To make room for new data, the system periodically purges the data that is used for password reset monitoring and reporting.

### Password Reset Overview module

The **Password Reset > Overview** module displays reports on password reset and password change activities. Users with the password_reset_admin role can customize the layout of the reports that appear in the Overview module.

#### Password Reset reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Requests (last 7 days)</td>
<td>Number of password reset requests by type during the last 7 days.</td>
</tr>
<tr>
<td>Blocked Users (last 7 days)</td>
<td>Number of users blocked over the last 7 days.</td>
</tr>
<tr>
<td>Password Reset Request Status (last 7 days)</td>
<td>Status of all password reset requests by process.</td>
</tr>
<tr>
<td>Password Reset Request by Action (last 30 days)</td>
<td>Number of password reset requests by action type: Reset Password, Unlock Account, or Reset and Unlock.</td>
</tr>
<tr>
<td>Password Reset Top Users (last 30 days)</td>
<td>Number of password reset requests per user. Many password reset requests from a single user could indicate a security issue.</td>
</tr>
<tr>
<td>Password Reset Failed Verifications (last 7 days)</td>
<td>Number of failed verification attempts, by verification instance. A failed verification occurs when a user attempts to reset the password, but fails for one reason or another, during the identity verification step. Many failed verification attempts for a specific type of verification could indicate that the process is too complicated or unclear.</td>
</tr>
<tr>
<td>Password Reset Enrollment By Verification</td>
<td>Number of users by verification type who enrolled and did not enroll in the password reset program. A large number for users who did not enrolled could indicate a compliance or communication issue within the organization.</td>
</tr>
<tr>
<td>Password Change Top Users (last 30 days)</td>
<td>Number of password change requests per user. Many password change requests from a single user could indicate a security issue.</td>
</tr>
</tbody>
</table>

### Password Reset activity log

The activity log (**Password Reset > Activity Log**) provides detailed information that you can use to troubleshoot and to generate reports on password reset metrics. Information contained in the activity log is stored in the Password Reset activity log [pwd_reset_activity] table.

You must have the password_reset_credential_manager or password_reset_admin role to view the log.
Password Reset event log

The event log is a valuable resource for troubleshooting. On the Start menu, click Programs (or All Programs) > Administrative Tools > Event Viewer.

If the log does not appear, then, on the Windows Logs menu, click Applications > Service Logs.

You must have the admin role to view the log.

To write to the Password Reset event log

Edit the DebugFlag registry key entry at: Computer > HKEY_LOCAL_MACHINE > SOFTWARE > Microsoft > Windows > CurrentVersion > Authentication > Credential Providers > {B6EFF27D-C1C4-481F-B81B-F3547C47D58A}

By default, the key is set to 0. Set the key to 1 to write log entries to the ServiceNowPwdReset event log.

You must have the password_reset_credential_manager or password_reset_admin role to write to the log.

Password Reset blocked user notification

You can receive email notifications when the number of users that are blocked or locked exceeds the password blocked threshold. Notifications can alert you to suspicious activities. The default threshold is 10.

To subscribe: Add an email notification device or modify an existing device and then subscribe to the Password Reset-Activity Monitor Lockout notification.

You must have the password_reset_credential_manager or password_reset_admin role to subscribe.

Schedule for purging Password Reset data

To make room for new data, the system periodically purges the data that is used for password reset monitoring and reporting. Information contained in reports and monitoring tools could change dramatically immediately after a data purge.

Users with the password_reset_credential_manager or password_reset_admin role can follow this procedure to modify the purge interval:

1. On a non-production instance: Navigate to Automated Test Framework > Administration > Table Cleanup.
2. Modify the designated tables.
3. Test all changes on the non-production instance.
4. Modify the tables on your production instance and test.

Alternatively, contact ServiceNow Technical Support to modify the purge interval.
Purge intervals for Password Reset tables

<table>
<thead>
<tr>
<th>Table name</th>
<th>Purge interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>[pwd_reset_request]</td>
<td>90 days (7,776,000 seconds).</td>
</tr>
<tr>
<td></td>
<td>Depending on your organizational data monitoring requirements, you could configure the rule to:</td>
</tr>
<tr>
<td></td>
<td>• Purge successful requests after 90 days</td>
</tr>
<tr>
<td></td>
<td>• Keep failed requests for 120 days</td>
</tr>
<tr>
<td>[pwd_user_lockout]</td>
<td>90 days (7,776,000 seconds).</td>
</tr>
<tr>
<td></td>
<td>Depending on your organizational data monitoring requirements, you could configure the rule to:</td>
</tr>
<tr>
<td></td>
<td>• Purge successful requests after 90 days</td>
</tr>
<tr>
<td></td>
<td>• Keep failed requests for 120 days</td>
</tr>
<tr>
<td>[pwd_reset_activity]</td>
<td>90 days (7,776,000 seconds).</td>
</tr>
<tr>
<td>[pwd_activity_monitor]</td>
<td>90 days (7,776,000 seconds).</td>
</tr>
<tr>
<td>[pwd_dvc_enrollment_code]</td>
<td>1 day (86,400 seconds).</td>
</tr>
<tr>
<td>[pwd_sms_code]</td>
<td>1 day (86,400 seconds).</td>
</tr>
</tbody>
</table>

User guide: Resetting your password

Your experience might differ, but the self-service process is a typical process that you might follow to reset your password.
Example experience of the self-service process

Your experience might differ, but here:

1. On the login page, you click the **Forgot Password?** link to start the process.
2. The Identify page opens and you enter your identifying information (typically username or email address). The example includes the default Google reCAPTCHA security feature:

![Identify page with CAPTCHA](image)

3. On the Verify page, you verify your identity by providing information that proves that you are who you say you are. The admin configured the method of verification and can require multiple verifications. In the example, the admin has configured the Security Question verification. You must answer a question to prove your identity. (Earlier, while enrolling for the password reset process, you selected the question and provided a secure private answer.) Other possible verifications require you to enter a code number that was sent to a mobile device by SMS text, through the Google Authenticator app, or by email.

![Security Question verification](image)
4. The system checks the credential store to verify your identity and then displays, on the Reset page, the new password.

Enroll in the Password Reset program

Some organizations auto-enroll users in a Password Reset program. Your organization could offer end users the option to enroll for one or more methods of verifying identity when resetting the password. End users can enroll for most Password Reset programs on a mobile device.

End users might enroll for any combination of the following methods:

**Verify your identity using security questions (QA verification)**

- To enroll, you choose multiple questions that only you can answer (like the name of your first pet) and then supply answers. The system stores your answers securely.
- Later, when you want to reset your password, the system presents one or more of the questions. You answer the questions to verify your identity. See

**Verify your identity using an SMS code (SMS verification)**
• To enroll, you authorize a device like a cellular phone for SMS verification.
• Later, when you want to reset your password, you get a code number on the device and enter the code on the web page to verify your identity.

Verify your identity using an Emailed code
• To enroll, you authorize one or more email addresses.
• Later, when you want to reset your password, the system sends a code number to the email address. You then enter the code on the web page to verify your identity.

Verify your identity using the Google Authenticator app
• You enroll on a computer that you normally use to access the instance (you use Google Authenticator to reset your password, but cannot use Google Authenticator to enroll for Password Reset Windows Application.). After you have enrolled, you load the Google Authenticator app on one or more devices and then authorize the devices for Google Authenticator verification.
• Later, when you want to reset your password, read the Google Authenticator code on your device and then enter the code on the web page to verify your identity.

Users: Enroll in the Password Reset program using questions and answers
Your organization might ask you to select the questions to use when resetting your password. You select the questions and provide answers that only you know. At another time, when you reset your password, your answers verify your identity. You can enroll on a mobile device.

Role required: none
The list of questions is presented in the language that you requested while logging in.
1. Navigate to Password Reset > Enroll and then click the QA Verification tab.
   If you are required to enroll for the QA verification method, then the tab is marked with an asterisk (*).
2. For each Question field, select a question from the list and then enter the answer in the Answer field. Repeat the process until the required number of Question and Answer fields are filled in.
3. Click Submit.
4. Optional: Enroll for an extra identity verification using any of the other methods that your organization offers. See:
   • Users: Enroll in the Password Reset program using SMS codes
   • Users: Enroll in the Password Reset program using Google Authenticator
   • Users: Enroll in the Password Reset program using emailed codes

Users: Enroll in the Password Reset program using SMS codes
To prove that you are who you say you are (verify your identity) while resetting your password, you can use a code number (the SMS code) that was delivered to your mobile phone or device. You can enroll on a mobile device.

Role required: none
1. Navigate to Password Reset > Enroll and then click the SMS Verification tab.
   If your organization requires you to enroll for the SMS verification method, then the tab is marked with an asterisk (*).
2. If you had previously added an SMS-enabled device to your Password Reset profile, the device is listed. To add and verify a device, click Add Device and then follow the instructions. Provide a meaningful Name for each device. Repeat the process for as many devices as you need.

3. After you verify each device, select the Authorized check box for each device that you expect to use to change or reset your password.

   Note: You can deauthorize a device at any time by clearing the Authorized check box.

4. Click Submit.

5. Optional: Enroll for an additional identity verification using any of the other methods that your organization offers. See:
   - Users: Enroll in the Password Reset program using questions and answers
   - Users: Enroll in the Password Reset program using Google Authenticator
   - Users: Enroll in the Password Reset program using emailed codes

**Users: Enroll in the Password Reset program using emailed codes**

To prove that you are who you say you are (verify your identity) while resetting your password, you enter a code that was sent to your email address. You can enroll for this program on a mobile device.

Role required: none

During this enrollment process, you add the email address, the system sends you a code so you can verify the address, and then you authorize the address to be used for the Password Reset process. By default, the system sends the code to the email address that is associated with your ServiceNow profile. You can send the code to additional email addresses.

1. Navigate to Password Reset > Enroll and then click the Email Verification tab.
   If your organization requires you to enroll for the Email verification method, then the tab is marked with an asterisk (*). Email addresses that were added previously are listed on the tab.

2. Click Add Email, enter the Email address and a meaningful Email name to associate with the address and then click Add Email. Repeat the process for as many email addresses as you need.

3. On the Email Verification tab, for each email that should receive Password Reset codes, click Verify. The system sends an email message with a code and then displays the Verify the Email Address pop-up.

4. On the Verify the Email Address pop-up, enter the code and click Verify. If this process fails, click Send a New Code to send a different code and try again.

5. After you verify each email address, select the Authorized check box for each address that you expect to use to change or reset your password.

   Note: To deauthorize an email address so that it does not receive Password Reset codes, clear the Authorized check box.

6. Click Submit.

7. Optional: Enroll for an additional identity verification using any of the other methods that your organization offers. See:
   - Users: Enroll in the Password Reset program using questions and answers
   - Users: Enroll in the Password Reset program using SMS codes
   - Users: Enroll in the Password Reset program using Google Authenticator
Users: Enroll in the Password Reset program using Google Authenticator

To prove that you are who you say you are (verify your identity) while resetting your password, you get a code number from Google Authenticator on your cell phone or mobile device and then enter the code on the Password Reset web page. If you already paired a device (for example, to log in to the ServiceNow instance), you can skip this enrollment process.

Role required: none

You cannot enroll for the Password Reset program on a mobile device.

1. Navigate to **Password Reset > Enroll** and then click the **Google Authenticator Verification** tab.
   
   **Note:** If your organization requires you to enroll for the Google Authenticator verification method, then the tab is marked with an asterisk (*).

2. Download the Google Authenticator app to your device.
3. Open the app and then use the device to scan the QR code on the tab.
4. When the device generates a code, enter the code in the text box and then click **Pair Device**.
5. Click **Submit**.
6. Optional: If the system displays a success message, click **Submit**. If the system displays a failure message, enter the code again, click **Pair Device**, and then click **Submit**.

When you submit the enrollment, the tab displays the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate New QR Code</td>
<td>Enables you to pair a device with a new code. This option is useful if you have a new device. Existing multi-factor authentication data is replaced with the new data.</td>
</tr>
<tr>
<td>Disable Multi-factor Authentication</td>
<td>Deletes existing multi-factor authentication data. The Google Authenticator verification is no longer available.</td>
</tr>
</tbody>
</table>

7. Optional: Enroll for an additional identity verification using any of the other methods that your organization offers. See:
   - Users: Enroll in the Password Reset program using questions and answers
   - Users: Enroll in the Password Reset program using SMS codes
   - Users: Enroll in the Password Reset program using emailed codes

**Users: Reset your password on Windows systems**

If your organization uses the Password Reset Windows Application, you can reset your password directly from your Windows login screen.
Role required: none

1. Start your computer or press **Ctrl+Alt+Delete** to go to the Windows login screen.
2. Click the Forgot Password? link. (Your administrator may configure different text for the link.)
3. On the Identify page, enter the requested information and then click Next.
4. On the Verify page, enter the requested information, and then click Next.

**Note:** You might be given the option to choose the method used to verify your identity.

If your identity is verified, the Reset page displays whether you were successfully verified and the state of your account (either locked or unlocked).

5. Based on your locked/unlocked state, perform one of the following actions:
   - If your account is not locked, the page displays the Reset Password button. Enter and reenter the new password and then click Reset Password.
   - If your account is locked, the page displays the Reset Password and Unlock Account buttons.
     - You can enter a new password and click Reset password to reset the password and unlock the account.
     - If your administrator has selected Enable account unlock for the password process, you can unlock the account without resetting the password by clicking Unlock account.

**Remote tables**

Connect the Now Platform to third-party sources, or to another instance, so that you can retrieve external data and optionally cache it in the memory. You can view external data in lists or forms and process it with standard Glide scripts. You can also group, sort, aggregate, and filter the data just like you would for standard internal tables.

**Remote table components**

Use the following components to build an external data framework:

**Remote tables**
You create remote tables to describe the schema for the data that you want to retrieve from an external source.

The table definition is in the Now Platform, but its rows, or external records, live in the memory. You create a remote table the same way that you would create a standard internal table. You define columns and controls and designate application access for it just like you would do for an internal table. Unlike an internal table, a remote table does not get its records from the Now Platform database. It gets its records from running an associated script against an external data source.

To learn more about creating remote tables, see Create a remote table.

**Script definitions**

You create and associate a script definition with a remote table. The external data that you've retrieved using the script can be cached in the memory. You can also designate how this data is cached and how long the data is cached in the memory. Every time that you refresh a list that contains the external data from a remote table, the associated script runs again.

To learn more about script definitions and how to associate them with a remote table, see Create a script definition for a remote table.

**How remote tables work**

By using a remote table, you can retrieve the data from external sources or from another instance with REST or SOAP services. The external data lives in the memory in read-only mode, which makes the data temporary, or transient, within the Now Platform. You can then view and manipulate the external data without importing or storing it.

You view the external data in lists or forms in the same way that you view internally stored data. You can manipulate this data by using standard Glide records, business rules, remote APIs, scripting, table reference fields, services, and development tools in the Now Platform.

---

**Important:** All data that is retrieved from the external source lives in the memory, so make sure that your data set is small. To minimize query times, don't add more than 1000 rows to a remote table.

**External data life cycle within the Now Platform**

The data that you retrieve from an external source has a finite duration, or life cycle, within the Now Platform.

- When you run a script that is associated with a remote table, the retrieved data lives in the memory for as long as the list or form appears. After you close the list or form, that external data is purged from the memory. The next time that you use or view the external data in this remote table, the memory is repopulated from the external system.
- However, if you have defined caching parameters for the script, the external data remains cached in the memory for the specified caching duration.

For example, if you designate that the external data should be cached for 300 seconds, it remains cached in the memory for 5 minutes. After that time expires, the cached data is purged from the memory. The next time that you use or view the external data in this remote table, the cache is refreshed from the external system.
Practical applications for remote tables

Set up and use remote tables in your enterprise when:

- You want to fetch external data for temporary use without storing it in the Now Platform. For example, you can create a remote table that fetches weather-related data that appears on a homepage when a user logs in. You would then create an associated script definition that retrieves this data from a third-party weather source that is based on the user's location.
- You want to retrieve customer details that are stored in an external Customer Relationship Management (CRM) application for viewing in Customer Service Management functions such as Agent Workspace.
- You want to retrieve and view personnel data from Human Capital Management (HCM) applications such as Workday or SAP SuccessFactors for use in HR Service Delivery functions.

Post-filtering and sorting

When you run a remote table script, it applies post-filtering and sorting query conditions after it adds rows to a table. These applied conditions support any other required queries that the script does not handle. When you apply post-filtering and sorting, the remote table queries work like standard internal table queries.

When you create remote table scripts, you generally handle the most frequent and expansive queries in the script. Post-filtering queries and sorting can take a long time and may adversely affect how your instance performs. Use a small data set instead so that it doesn't take much time to do post-filtering and sorting.

Based on your use cases, determine if you should try a narrower query in the external call or a more expansive query. Because the internal filtering and sorting can be expensive to run on large result sets, use a narrower query when the data doesn't require extra filtering. Use a more expansive query when a more general query would return a small result set and would require extra filtering and sorting.

Differences between remote tables and the IntegrationHub

Choose whether to use a remote table or IntegrationHub to process external data.

- When you want to temporarily cache external data for viewing, use remote tables.
- If you want more advanced importing and transformation options, including Flow Designer, or if you want to develop custom integrations, use the IntegrationHub.

Note: If you create a remote table that uses the data from an external source that is outside of the Now Platform, you must have an IntegrationHub subscription entitlement. To learn more about the IntegrationHub, see IntegrationHub.

Activate the remote tables plugin

If you have the admin role, you can activate the Remote Tables plugin (com.glide.script.vtable). This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

Remote Tables activates these related plugins if they are not already active.
Plugins for Remote Tables

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Tables</td>
<td>Supports remote tables and associated script definitions that can be used to retrieve and optionally cache data from external sources.</td>
</tr>
<tr>
<td>[com.glide.script.vtable]</td>
<td></td>
</tr>
<tr>
<td>Transformation Service</td>
<td>Supports use of Transform APIs that are associated with the remote tables.</td>
</tr>
<tr>
<td>[com.glide.transform]</td>
<td></td>
</tr>
</tbody>
</table>

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: **Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>**.

Create a remote table

Create a remote table so that you can see the data that you retrieved from an external source.

Role required: admin

When you designate a table as a remote table, keep the following points in mind:

- You can create a remote table using this form, or by using the standard Create Tables form that you access from **System Definition > Tables**.

   **Note:** To learn more about creating tables in an instance, see **Create a table**.

- Before you create a remote table, you must have a good understanding of external data sources.
  For example, if you want to retrieve CRM data for use in Customer Service Management, you must understand how the data is structured in the external CRM source.
- Unlike standard internal tables, you can’t extend a remote table from another table.
- A remote table needs an external primary key to relate its temporary data to the data that is stored in the external source. When you designate a table as remote, only a sys_id field is auto-generated and appears in the Columns section, which it uses as its primary key for use in Glide records. All external table primary key values are converted to string values. CRUD (Create, Read, Update, Delete) fields are not generated for a remote table, as they are for standard internal tables.

1. Navigate to **System Definition > Remote Tables > Tables**.
2. Click **New**.
3. On the form, fill in the fields.

**Note:** You create a remote table in the same manner as a normal table, but designate it as a remote table. The following controls differ in how they operate and what you enter into them when you create a remote table:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name             | Table name, which is automatically populated based on the table label and a prefix as follows:  
|                  | - For a remote table in a scoped application, the name is prefixed with a namespace identifier and the string st_ to indicate that it is remote and part of an application.  
|                  | - For a remote table in the global application, the name is prefixed with the string u_st_.  
|                  | You can't modify the prefix; however, you can modify the rest of the table name. The name can contain only lowercase, alphanumeric ASCII characters and underscores (_). |
| Extends Table    | Option that is not available if you select the Remote Table option to designate that this table is remote. It no longer appears because you can't extend remote tables from other tables. |
| Remote Table     | Option to designate this table as a remote table. A remote table is a table to which you can associate a script definition for retrieval of data from an external data source. Unlike a standard internal table, the data does not come from records in the current instance.  
|                  | **Note:** To learn more about remote tables, see:  
|                  | - Remote tables  
|                  | - Create a remote table |

4. In the Columns section, use the **Table Columns** embedded list to add columns to the remote table like you do when you create columns for a standard internal table.

5. In the Controls section, define additional remote table options like you do when you define additional table options for a normal table.

6. In the Application Access section, define the scope protection for the remote table like you do when you define additional table options for a normal table. For more information, see Application access settings.

7. Click **Submit**.

A remote table is created in the instance.

**Create a script definition for a remote table**

Define and associate a script with a remote table so that you can retrieve data from an external source with it. The Now Platform retrieves and caches the data for the remote table by running the script against an
external data source so you can view or modify it. You can also designate how this external data is cached and how long the data is cached in the memory until the script must run again.

Role required: admin

You create script definitions for remote tables like you do for other scripts. To learn more about entering, modifying, and debugging scripts, see JavaScript syntax editor.

1. Navigate to System Definition > Remote Tables > Definition.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the script that you are creating to associate with the selected remote table.</td>
</tr>
<tr>
<td>Table</td>
<td>Name of the remote table that you want to associate the script that you are creating.</td>
</tr>
<tr>
<td></td>
<td>• For a remote table in a scoped application, the name is prefixed with a namespace identifier and the string st_ to indicate that it is remote and part of an application.</td>
</tr>
<tr>
<td></td>
<td>• For a remote table in the global application, the name is prefixed with the string u_st_.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that is associated with this remote table. If you are working on an application or are creating a remote table from an application record, the field defaults to that application. Otherwise, the field defaults to Global. Any records that are created from the table record, such as modules and security rules, are assigned to this application by default.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the script that you are associating with the remote table. You can have multiple inactive script definitions for a remote table, but can only have one active script definition.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Option to access the Caching section to designate how the memory caching should operate in the Now Platform for this remote table.</td>
</tr>
</tbody>
</table>

Note: Only advanced users should set caching parameters for a remote table.
4. In the Script section, add your JavaScript syntax to the skeleton template:

```javascript
(function executeQuery(v_table, v_query) {
  // Main API:
  // v_table.addRow({ ... }) - adds a row to the result set

  // There are also query helper methods
  // v_query.getEncodedQuery() - returns encoded querystring
  // v_query.getCondition(field) - returns encoded querystring
  // and value
  // v_query.getParameter(field) - returns parameter for the given condition
  // v_query.isTrue() - returns whether the query is a single condition
  // v_query.getSysId() - returns parameter for sys_id field
  // v_query.isTextSearch() - returns whether the query contains
  // v_query.getTextSearch() - returns text search query parameters
  // v_query.getFirstRowWanted() - returns the first row to include
  // v_query.getLastRowWanted() - returns the last row to include

  // Your code goes here
  // v_table.addRow({...})
})(v_table, v_query);
```

**Note:** To learn more about entering, modifying, and debugging scripts, see JavaScript syntax editor.

5. In the Caching section, designate how this data is cached and how long the data is cached in the memory of the Now Platform:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache TTL</td>
<td>Cache time to live, expressed in seconds, that external data is cached in memory for this remote table script definition. For example, enter 300 to cache the data in the memory for 5 minutes. The maximum value you can enter is 60 minutes (3600 seconds).</td>
</tr>
</tbody>
</table>

**Note:** By default, the external data is cached in the memory by user.

6. Click **Submit**.

When you activate a script definition, you associate it with the remote table so that you can retrieve and cache the external data.
Example 1: Retrieving all incident records from an external source

These are examples of script definitions you might create for retrieval and caching of data from sources external to your current instance. In this first example, we create a script to load all incident records from an external source.

```javascript
/**
 * Using `v_query`, add the rows to `v_table`
 */
(function executeQuery(v_table, v_query) {
    fetchAllIncidents(v_table, v_query);
    /**
    * fetch all incidents records from the remote instance
    */
    function fetchAllIncidents(v_table, v_query) {
        // Uses RestMessage with name 'Remote Instance Incidents' and function 'All Incidents'
        // Create a RestMessage first which calls an external REST service
        try {
            var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents',
                'All Incidents');
            var response = restMessage.execute();
            var responseBody = response.getBody(); // if REST call ends up in an error, set the last error message which shows up
            if (response.haveError()) {
                v_query.setLastErrorMessage(response.getErrorMessage());
                // gs.debug() messages visible in session debugger
                // gs.debug(response.getErrorMessage());
                return;
            } catch (ex) {
                v_query.setLastErrorMessage(ex.message);
                // gs.debug(ex.message);
                return;
            }
        }
        var transformerDefinition = getTransformerDefinition();
        var transformer = new sn_tfrm.Transformer(transformerDefinition,
            responseBody);
        // transformer parses the responseBody and extracts rows
        while (transformer.transform()) {
            // row is field-value map e.g. { active:"true", number: "INC0000001"}
            var row = transformer.getRow();
            // you may do any additional transformations to the row like GlideDuration, GlideDataTime etc. For example,
            // row.duration = new GlideDuration(row.duration);
            // finally add the row to the remote table
            v_table.addRow(row);
        }
    }
    /**
    * returns a sn_tfrm.TransformerDefinition, which defines the mapping of the table fields and elements in the response body
    */
```
function getTransformerDefinition() {
    // create a rule list to map a field to its element path
    var ruleList = new sn_tfrm.TransformerRuleList()
        .fromJSON() // the response body is a JSON
    // 'active' field maps to path '$.active'
        .addRule("active", "$.active")
    // 'caller_id' field maps to path '$.caller_id.value'
        .addRule("caller_id", "$.caller_id.value")
    // 'number' field maps to path '$.number'
        .addRule("number", "$.number")
    // 'short_description' field maps to path '$.short_description'
        .addRule("short_description", "$.short_description")
    // 'sys_id' field maps to path '$.sys_id'
        .addRule("sys_id", "$.sys_id")
    // 'updates' field maps to path '$.sys_mod_count'
        .addRule("updates", "$.sys_mod_count");

    var recordPath = "$.result";
    return new sn_tfrm.TransformerDefinition(ruleList, recordPath);
}

var transformerDefinition = getTransformerDefinition();
var transformer = new sn_tfrm.Transformer(transformerDefinition, responseBody);
// transformer parses the responseBody and extracts rows
while (transformer.transform()) {
    // transformer processes each row
}

These code snippets are of note in this script:

You can create a RestMessage and directly use it in the script. In this example, it uses a RESTMessageV2 API with the name of Remote Instance Incidents, and the function All Incidents, which gets all incident data. Once a response is returned from the server, an error message appears if problems are encountered in the data retrieval.

**Note:** To learn more about use of RESTMessageV2 and how to define a direct message, see RESTMessageV2 - Scoped, Global and Direct RESTMessageV2 example.

If no problems are encountered in the data retrieval, it gets the data body for the records.
It then uses the Transformer API to perform any required data transformations, extracts rows, and then adds a row for each record to the remote table.

```javascript
/**
 * returns a sn_tfrm.TransformerDefinition, which defines the mapping of the table fields and elements in the response body
 */
function getTransformerDefinition() {
// create a rule list to map a field to its element path
var ruleList = new sn_tfrm.TransformerRuleList()
  .fromJSON() // the response body is a JSON
  // 'active' field maps to path '$.active'
  .addRule("active", ".active")
  .addRule("caller_id", ".caller_id.value")
  .addRule("number", ".number")
  .addRule("short_description", ".short_description")
  .addRule("sys_id", ".sys_id")
  .addRule("updates", ".sys_mod_count");

  var recordPath = ".result";
  return new sn_tfrm.TransformerDefinition(ruleList, recordPath);
}

getTransformerDefinition defines the schema of the record in the external API response body. It maps each of the fields in the table script to an element in the external record. Any external data elements outside of this mapping are not supported or retrieved.

**Note:** You must map a sys_id in the transformer definition to an element in the external data. In this case, the sys_id is mapped to the external incident sys_id. The maximum length of the sys_id is 32 characters. You do this sys_id mapping so forms that use the external data can operate properly.

Example 2: Retrieving specific records from a third-party source

In this example, we create a script to retrieve specific types of incident records from a third-party source.

```javascript
/**
 * Using `v_query`, add the rows to `v_table`
 */
(function executeQuery(v_table, v_query) {
  if (v_query.isGet()) {
    bySysId(v_table, v_query, v_query.getSysId());
  } else if (v_query.getParameter("caller_id")) {
    byCallerId(v_table, v_query, v_query.getParameter("caller_id"));
  } else {
    fetchAllIncidents(v_table, v_query);
  }
})
```
/**
* fetch all incidents records from the remote instance
*/
function fetchAllIncidents(v_table, v_query) {
// Uses RestMessage with name 'Remote Instance Incidents' and function 'All Incidents'
// Create a RestMessage first which calls an external REST service
var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents', 'All Incidents');
loadData(v_table, v_query, restMessage);
}

/**
* fetches a specific record from the remote instance with Sys Id being `sys_id`
*/
function bySysId(v_table, v_query, sys_id) {
// Uses RestMessage with name 'Remote Instance Incidents' and function 'By SysId'
var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents', 'By SysId');
// sets variable 'sys_id'
restMessage.setStringParameterNoEscape("sys_id", sys_id);
loadData(v_table, v_query, restMessage);
}

/**
* fetches records from the remote instance with Caller (caller_id) being `caller_id`
*/
function byCallerId(v_table, v_query, caller_id) {
var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents', 'By CallerId');
restMessage.setStringParameterNoEscape("caller_id", caller_id);
loadData(v_table, v_query, restMessage);
}

/**
* Adds rows to `v_table` using `restMessage`
*/
function loadData(v_table, v_query, restMessage) {
try {
var response = restMessage.execute();
var responseBody = response.getBody();

// if REST call ends up in an error, set the last error message which shows up
// at the bottom of the list view
if (response.haveError()) {
  v_query.setLastErrorMessage(response.getErrorMessage());
  // can use gs.error() or gs.addErrorMessage() while debugging
  // gs.debug() messages visible in session debugger
  // gs.debug(response.getErrorMessage());
  return;
}
catch (ex) {
  v_query.setLastErrorMessage(ex.message);
  // gs.debug(ex.message);
  return;
}
var transformerDefinition = getTransformerDefinition();
var transformer = new sn_tfrm.Transformer(transformerDefinition, responseBody);
// transformer parses the responseBody and extracts rows
while (transformer.transform()) {
  // row is field-value map e.g. { active:"true", number: "INC0000001"}
  var row = transformer.getRow();
  // you may do any additional transformations to the row like
  GlideDuration, GlideDateTime etc. For example,
  // row.duration = new GlideDuration(row.duration);

  // finally add the row to the remote table
  v_table.addRow(row);
}

/**
 * returns a sn_tfrm.TransformerDefinition, which defines the mapping of
 * the table fields and elements in the response body
 */
function getTransformerDefinition() {
  // create a rule list to map a field to its element path
  var ruleList = new sn_tfrm.TransformerRuleList()
    .fromJson() // the response body is a JSON
    // 'active' field maps to path '$.active'
    .addRule("active", 
      ".active")
    .addRule("caller_id", 
      ".caller_id.value")
    .addRule("number", 
      ".number")
    .addRule("short_description", 
      ".short_description")
    .addRule("sys_id", 
      ".sys_id")
    .addRule("updates", 
      ".sys_mod_count");

  var recordPath = "$.result";
  return new sn_tfrm.TransformerDefinition(ruleList, recordPath);
}
})(v_table, v_query);

These code snippets are of note in this script:

function fetchAllIncidents(v_table, v_query) {
  // Uses RestMessage with name 'Remote Instance Incidents' and function
  // 'All Incidents'
  // Create a RestMessage first which calls an external REST service
  var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents',
    // 'All Incidents');
  loadData(v_table, v_query, restMessage);
}

function bySysId(v_table, v_query, sys_id) {
  // Uses RestMessage with name 'Remote Instance Incidents' and function 'By
  // SysId'
  var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents', 'By
  // SysId');
  // sets variable 'sys_id'
  restMessage.setStringParameterNoEscape("sys_id", sys_id);
  loadData(v_table, v_query, restMessage);
}

You can create a RestMessage and directly use it in the script. In this example, it uses a RESTMessageV2
API with the name of Remote Instance Incidents, and the function All Incidents, which gets
all incident data. Once a response is returned from the server, an error message appears if problems are
encountered in the data retrieval.
When you query a specific record using `GlideRecord.get("<sys_id>")`, then `v_query.isGet()` is `true`. It fetches the specific record from the external service.

```javascript
function byCallerId(v_table, v_query, caller_id) {
  var restMessage = new sn_ws.RESTMessageV2('Remote Instance Incidents', 'By CallerId');
  restMessage.setStringParameterNoEscape("caller_id", caller_id);
  loadData(v_table, v_query, restMessage);
}
```

You can also handle any other specific query conditions in the script, such as using `caller_id` in the preceding code snippet. The remainder of this script operates in a manner similar to Example 1.

```javascript
function getTransformerDefinition() {
  // create a rule list to map a field to its element path
  var ruleList = new sn_tfrm.TransformerRuleList()
  .fromJSON() // the response body is a JSON
  // 'active' field maps to path '$.active'
  .addRule("active", "$\.active")
  .addRule("caller_id", "$\.caller_id.value")
  .addRule("number", "$\.number")
  .addRule("short_description", "$\.short_description")
  .addRule("sys_id", "$\.sys_id")
  .addRule("updates", "$\.sys_mod_count");

  var recordPath = "$\.result";
  return new sn_tfrm.TransformerDefinition(ruleList, recordPath);
}
```

If no problems are encountered in the data retrieval, it gets the data body for the records. It then uses the Transformer API to perform any required data transformations, extracts rows, and then adds a row for each record to the remote table.

`getTransformerDefinition` defines the schema of the record in the external API response body. It maps each of the fields in the table script to an element in the external record. Any external data elements outside of this mapping are not available in the remote table.

### Debugging remote table script definitions

You can enable session debugging for remote table script definitions. To enable script definition logging in a session debug log, set the `glide.script.vtable.log.debug` property to `true`.

When you create remote table script definitions, you can use the `gs.debug()` command to add debug logs that are visible in the session debugger. The session debugger also contains debug logs with `[RemoteTable]` tags, each with the following information:

- Query definition
- Number of rows loaded in the remote table
- Number of aggregate rows (if GlideAggregate)

Prolonged use of the `glide.script.vtable.log.debug` property can affect performance, so it is best to set its value to `false` when you finish a debugging session.

**Note:** If you are not on the application node that processed your remote table script, you may not see the resulting log statements. In this case, contact Technical Support.
Use the `v_query.setLastErrorMessage(message)` API to set the last error message that appears at the bottom of the list view. In script, you can retrieve this message using the `glideRecord.getLastErrorMessage()` API. To learn more about these APIs, see Text-To-Display.

**Domain separation and remote tables**

This is an overview of domain separation and remote tables. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Overview**

**Support: Data only**

Domain separation provides complete data isolation for domain-specific users. Domain separation in this application is supported at the Data only level, meaning it supports the data security model of separating visibility of data from one domain to another. To learn more, see Application support for domain separation.

**How domain separation works with remote tables**

When you create standard internal tables, you can add a sys_domain field, which results in domain separation of the data that is stored in the table. This functionality is not supported when you natively create remote tables, which results in lack of domain separation for rows that are added to a remote table.

However, script definitions that you create and associate with a remote table can be domain (data) separated. When you create the script, you can include DomainSupport APIs that provide domain separation support. If the script definition is domain separated, only users that belong to the designated domain can view the data in the remote table.

**Response templates**

Resolve cases or support issues faster and more efficiently with response templates. Response templates (formerly known as templated snippets) are reusable messages that can be copied to case or task forms to provide quick and consistent messages to users, or to display standard chat response messages to requesters in Agent Chat.

**Assign response template roles**

The following roles are installed when you activate the response templates plugin.

<table>
<thead>
<tr>
<th>Response template role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response template administrator</td>
<td>Grants access to scoped administration of the response templates feature.</td>
</tr>
<tr>
<td>[sn_templated_snip.template_snippet_admin]</td>
<td></td>
</tr>
<tr>
<td>Response template writer</td>
<td>Grants access to create, read, update, and delete (CRUD) response template content.</td>
</tr>
<tr>
<td>[sn_templated_snip.template_snippet_writer]</td>
<td></td>
</tr>
<tr>
<td>Response template reader</td>
<td>Grants access to read response template content.</td>
</tr>
<tr>
<td>[sn_templated_snip.template_snippet_reader]</td>
<td></td>
</tr>
</tbody>
</table>
Before you begin using response templates, you must assign these roles to the appropriate roles, groups, or users in your application.

- To assign a role to another role, see Add a role to an existing role.
- To assign a role to a group, see Assign a role to a group.
- To assign a role to a user, see Assign a role to a user.

For example,

- In the HR Service Delivery application, users with the HR administrator role are assigned the response template administrator role, users with the HR manager role are assigned the response template writer role, and users with the HR case writer role are assigned the response template reader role.
- In the Customer Service Management application, users with the customer service manager role (sn_customerservice_manager) inherit the response template writer role. Users with the customer service agent role (sn_customerservice_agent) inherit the response template reader role and can access response templates assigned to all groups to which they belong.
How to use response templates

Users with the response template writer [sn_templated_snip.template_snippet_writer] role can create response templates. Each template is associated with a table that is an extension of the Task [task] or Interaction [interaction] table. Response templates include a short name for specifying a shortcut that can be used to identify the message. For chat response templates used in Agent Workspace, agents use the slash command with a short name to present the standard message during a chat. You can also configure the template to

• Include variables pulled from a table
• Specify a condition builder to specify the conditions that must be met for the template to be available for use, such as for a specific HR service

• Create or modify a response template

Users with the response template reader [sn_templated_snip.template_snippet_reader] role can then copy response template content and use it in their responses to users when working on case or task forms that meet the specified conditions. For example, a response template for payroll discrepancy cases enables HR agents to use a standardized message when responding to that case type. See Copy a response template to an HR case for an HR-specific example.

Response template to escalate payroll discrepancy cases

You are part of an enterprise HR organization using the HR Service Delivery application. You want your HR agents to respond to and, when necessary, escalate payroll discrepancy cases quickly and consistently. Create a response template so that HR agents have a reusable message to use when responding to employees about that case type.

One of your HR managers with the response template writer role is responsible for creating the template to escalate payroll discrepancy cases. The template is associated with the HR Payroll Case [sn_hr_core_case_payroll] table, and a condition filters on cases that match the appropriate HR service called Payroll Discrepancy. In the template body, the response text appears with variables, such as the subject person name in the salutation.

HR case writers with the response template reader role can copy the response template content and use it in their responses to employees when working on cases. Response templates provide a faster and efficient way to resolve cases.

Activation information

To use response templates in your application, you must activate response templates. For information on what components are installed with the feature, see Components installed with response templates.

Activate response templates

You can activate response templates (formerly known as templated snippets) [com.sn_templated_snip] if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

Note: If you are using Agent Chat, the Agent Chat (com.glide.interaction.awa) plugin automatically activates response templates.

Response templates activate these related plugins if they are not already active.
Plugins for response templates

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scoped Application Restricted Caller Access</td>
<td>Allows scoped applications to restrict access to public tables and script includes.</td>
</tr>
</tbody>
</table>

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with response templates

Several types of components are installed with activation of the response templates (formerly known as templated snippets) plugin, including tables and user roles.

   **Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response templates administrator [sn_templated_snip.template_snippet_admin]</td>
<td>Grants access to scoped administration of the response templates feature.</td>
<td>• sn_templated_snip.template_snippet_writer</td>
</tr>
<tr>
<td>Response templates writer [sn_templated_snip.template_snippet_writer]</td>
<td>Grants access to create, read, update, and delete (CRUD) response template content.</td>
<td>• sn_templated_snip.template_snippet_reader</td>
</tr>
<tr>
<td>Response templates reader [sn_templated_snip.template_snippet_reader]</td>
<td>Grants access to read response template content.</td>
<td>• None</td>
</tr>
</tbody>
</table>

You can assign these roles to the appropriate roles, groups, or users in your application.

- To assign a role to another role, see Add a role to an existing role.
- To assign a role to a group, see Assign a role to a group.
- To assign a role to a user, see Assign a role to a user.

For further information on user administration and how to manage users, see User administration.
Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note Template</td>
<td>Table for templated snippets.</td>
</tr>
<tr>
<td>[sn_templated_snip_note_template]</td>
<td></td>
</tr>
</tbody>
</table>

For further information on table administration and how to manage data, see Table administration.

Create or modify a response template

Create or modify a response template (formerly known as a templated snippet) to define a reusable message that can be copied to case or task forms or used in Agent Chat sessions to provide quick and consistent messages to users.

Role required: sn_templated_snip.template_snippet_writer

Each response template is associated with a table that is an extension of the Task [task] table or, if using Agent Workspace, the Interaction [interaction] table. The template can be configured to include variables pulled from that table. You can also use a condition builder to specify the conditions that a case must meet for the template to be available for use, such as for a specific HR service or for chat. For chat response templates, you specify a short name (shortcut) that is used with the slash command as a quick way to present the response message to a user.

1. Navigate to System Definition > Response template configuration.
2. Click New or open a record.
3. Fill in the fields on the form.

Response template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the response template.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Short description that identifies the response template when using chat in Agent Workspace. The short name is used with a quick command (/) to show the text from the template body of the response template while in chat. This feature provides a fast and consistent way to populate text while in chat. For example, the short name gm identifies the chat response template for a Good Morning greeting. Enter /gm in a chat window to show the text from this response template.</td>
</tr>
<tr>
<td>Table</td>
<td>Name of the table that the response template is associated with.</td>
</tr>
</tbody>
</table>

Note: If you are creating a response template for Agent Workspace chat, the associated table is the Interaction [interaction] table. For other response templates, the table must be an extension of the Task [task] table.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Conditions under which the response template is made available for use.</td>
<td>Note: The conditions available depend on the table you select. For chat response templates, specify the condition: [Type] [is] [Chat]</td>
</tr>
<tr>
<td>Application</td>
<td>The application that created the response template.</td>
<td></td>
</tr>
<tr>
<td>Group visibility</td>
<td>Indicates what groups have access to the response template. Adding groups filters who can view the response template.</td>
<td>Note: Leaving this field blank makes the response template available to all groups.</td>
</tr>
<tr>
<td>Template body</td>
<td>Text of the response template.</td>
<td>Note: Rich text is not supported with response templates.</td>
</tr>
<tr>
<td>Select variables</td>
<td>Variables that can be added to the template body.</td>
<td>Note: The variables available depend on the table you select.</td>
</tr>
</tbody>
</table>

The following GIF shows an example of an HR manager in the HR Service Delivery application creating a response template to escalate payroll discrepancy cases. The template is associated with the HR Payroll Case [sn_hr_core_case_payroll] table, and a condition is set to filter on cases that
match the Payroll Discrepancy HR service. The template text is pasted into the body, and then a variable for the subject person is added to the salutation.

4. Click **Submit** or **Update**.

You can copy response template content to any field on a form that meets the specified conditions.
The following GIF shows an example of an HR case writer in the HR Service Delivery application opening a payroll discrepancy case and copying a payroll discrepancy escalation template to the comments field in the HR case form for the employee to read.
<table>
<thead>
<tr>
<th>Number</th>
<th>State</th>
<th>Opened for</th>
<th>Subject person</th>
<th>HR service</th>
<th>Short description</th>
<th>Assignment group</th>
<th>Assigned to</th>
</tr>
</thead>
<tbody>
<tr>
<td>HRC001037</td>
<td>Ready</td>
<td>Eva Seehorn</td>
<td>Eva Seehorn</td>
<td>Payroll Discrepancy</td>
<td>Payroll discrepancy</td>
<td>HR Tier 1</td>
<td></td>
</tr>
<tr>
<td>HRC001036</td>
<td>Ready</td>
<td>Gale Nolau</td>
<td>Gale Nolau</td>
<td>Employee Payroll Setup Request</td>
<td>Employee Payroll Setup Request</td>
<td>HR Tier 1</td>
<td></td>
</tr>
<tr>
<td>HRC001030</td>
<td>Work in Progress</td>
<td>Gale Nolau</td>
<td>Phillipe Bertrand</td>
<td>Request Onboarding</td>
<td>Request Onboarding case for Phillipe Bertrand</td>
<td>HR Onboarding</td>
<td>Carol Coughlin</td>
</tr>
<tr>
<td>HRC001029</td>
<td>Ready</td>
<td>Gale Nolau</td>
<td>Gale Nolau</td>
<td>Employee Payroll Setup Request</td>
<td>Employee Payroll Setup Request</td>
<td>HR Tier 1</td>
<td></td>
</tr>
<tr>
<td>HRC001023</td>
<td>Work in Progress</td>
<td>Gale Nolau</td>
<td>Susan Taylor</td>
<td>Request Onboarding</td>
<td>Request Onboarding case for Susan Taylor</td>
<td>HR Onboarding</td>
<td>Christen Mitchell</td>
</tr>
<tr>
<td>HRC001022</td>
<td>Ready</td>
<td>Gale Nolau</td>
<td>Gale Nolau</td>
<td>Employee Payroll Setup Request</td>
<td>Employee Payroll Setup Request</td>
<td>HR Tier 1</td>
<td></td>
</tr>
<tr>
<td>HRC001016</td>
<td>Work in Progress</td>
<td>Gale Nolau</td>
<td>Willis Jones</td>
<td>Request Onboarding</td>
<td>Request Onboarding case for Willis Jones</td>
<td>HR Onboarding</td>
<td>Bob Woodbyrne</td>
</tr>
<tr>
<td>HRC001015</td>
<td>Ready</td>
<td>Gale Nolau</td>
<td>Gale Nolau</td>
<td>Employee Payroll Setup Request</td>
<td>Employee Payroll Setup Request</td>
<td>HR Tier 1</td>
<td></td>
</tr>
<tr>
<td>HRC001014</td>
<td>Ready</td>
<td>Gale Nolau</td>
<td>Timothy Emilii</td>
<td>Request Relocation Assistance</td>
<td>Request Relocation Assistance</td>
<td>HR Tier 1</td>
<td></td>
</tr>
<tr>
<td>HRC001013</td>
<td>Ready</td>
<td>Gale Nolau</td>
<td>Timothy Emilii</td>
<td>Work Visa Transfer Request</td>
<td>Employee Work Visa Transfer Request</td>
<td>HR Tier 1</td>
<td></td>
</tr>
<tr>
<td>HRC001013</td>
<td>Ready</td>
<td>Gale Nolau</td>
<td>Timothy Emilii</td>
<td>Work Visa Transfer Request</td>
<td>Employee Work Visa Transfer Request</td>
<td>HR Tier 1</td>
<td></td>
</tr>
<tr>
<td>HRC001013</td>
<td>Ready</td>
<td>Gale Nolau</td>
<td>Timothy Emilii</td>
<td>Work Visa Transfer Request</td>
<td>Employee Work Visa Transfer Request</td>
<td>HR Tier 1</td>
<td></td>
</tr>
</tbody>
</table>
**Self-service**

The Self-Service application gives supported end users a clean, simple front end to their IT support organization.

By default, the Self-Service application provides access to common actions, such as viewing your homepage, accessing the Service Catalog, viewing knowledge articles, working with incidents, and taking surveys.

**Service catalog requests**

This page contains links to content on service catalog requests.

**Add new request items**

Use ServiceNow's web-based interface to add new items to a request.

Roles required: Only an administrator or a user with the catalog_admin role can add a new item to a submitted request.

Modifying a request does not resubmit it to the approval process.

1. Navigate to **Service Catalog > Open Records > Requests** and open an existing request.
2. Click **Add New Item**.
3. In the dialog box that appears, choose an item and a quantity to add.
4. Click **OK**.

**Amazon EC2 instance request from the Service Catalog**

Users can request the provisioning and deletion of virtual computers (Linux or Windows) in the Amazon EC2 virtual computing environment through the ServiceNow Service Catalog.

The Amazon EC2 offering requires the purchase and activation of ServiceNow Orchestration Automaton.

**Request an instance**

Request the provisioning of a new Amazon EC2 instance through the service catalog.

1. Navigate to **Self-Service > Service Catalog**.
2. Select **Amazon EC2 Instance** from the **Request Application Infrastructure** category.

![EC2 Service Catalog](image)

EC2 Service Catalog 2

3. Select the operating system, the type of instance (Large or Small), and the number of instances requested.

See the specifications for Large and Small instances in Amazon EC2 Instance Types.
4. Type a reason for the request.

EC2 Service Catalog
5. Click Order Now to order the instance.

The Order Status form appears, summarizing the request. A status bar tracks the progress of the approval and provisioning of the EC2 instance.

![EC2 Order Status](image)

Upon successful creation of the instance, you receive an email containing the instance ID, IP address, and the public DNS for the instances created.

**Terminate an instance**

Shut down an Amazon EC2 instance through the service catalog.

1. Navigate to Service Catalog > Routine Changes > Terminate Amazon EC2 Instance.
   A list appears displaying the instances that are assigned to you.
2. Select an instance from the list and click Order.
   This list does not support multi-line selection, and there is no undo feature.

**Check-out redirect property**

A property called One-step checkout redirect (glide.vm.checkout_redirect) controls the view presented to virtual machine requesters in the service catalog.

By default, this property is set to false, which redirects the view to the Order Status form when the requester clicks Order Now. When this property is set to true, ServiceNow redirects the requester to his or her My Virtual Assets portal. This property is located in Cloud Management > Administration > Properties.

**Delete request items**

Use ServiceNow's web-based interface to delete items from a request.
All users can delete items from their own requests any time prior to delivery. Modifying a request does not resubmit it to the approval process.

1. Navigate to Service Catalog > Open Records > Requests and open an existing request.
2. In the Requested Items related list, select the check box beside the item to delete.
3. In the Actions choice list, select Delete.

ServiceNow recalculates the price and delivery date for the order.

Place a request

Use ServiceNow's web-based interface for ordering predefined goods and services.

1. Navigate to Self-Service > Service Catalog.

The default catalog view organizes items in categories and subcategories.

Add Categories

Search

Service Catalog

☐ Can We Help You?
- Create a New Incident
- Reset a Password
- Schedule a Move
- Report a Performance Problem
- Report an Outage

☐ On Boarding Services
- New Employee Hire

☐ Emergency Changes
- Server Reboot
- Database Restore

☐ Routine Changes
- DNS Change
- Add SAN Storage

☐ Request Computers and Handhelds
- Blackberry
- Development Laptop
- Executive Desktop
- Notebook Computer Loaner
- Office Desktop
- Office Printer
- Sales Laptop
- Telephone Extension

☐ Request Application Infrastructure
- Services
- Application Server (Large)
- Application Server (Standard)
- Database Server & Oracle License

Default catalog view

2. Select an item to order.

Note: Some items are order guides, which combine related items for easier ordering. For example, an order guide called New Employee Hire presents a list of items that new employees typically receive (desk, phone, computer, email account). After you select the items...
you want to order, the order guide requests the information required and shows a separate
time to delivery for each item ordered.

The order screen requests any additional information that's needed, such as the requester's name or
location and the date the item is needed. It also displays the item's delivery time after approval.

Delivery time

3. Enter complete and accurate information to expedite your order.
4. Order any other items required.
5. Click **Order Now** when the order is complete.

ServiceNow displays a confirmation screen for your order:

![Order Status](image)

**Order Placed: 2012-12-06 15:01:26**

**Request Number:** REQ0010004   [Bookmark request](#)

Estimated Delivery Date of Complete Order: **2012-12-11**

**Description (Includes Monthly Charges)** | **Delivery Date** | **Stage** | **Price (ea.)** | **Qty** | **Total** |
--- | --- | --- | --- | --- | --- |
IBM Thinkpad X60 | 2012-12-11 | | $3,000.00 | 1 | $3,000.00 |
| | | | +$100.00 Monthly | | +$100.00 Monthly |

**Total** | **$3,000.00** | **+$100.00 Monthly** |

You can view the order's progress in the **Stage** column.

**Note:** It may be useful to note the order number for future reference.

ServiceNow automatically notifies the approvers if approval is required and creates work orders to fulfill the order according to your organization's process. For example, if you order a new notebook computer, the purchasing group might receive a work order to order the computer, and the desktop services group might receive a work order to configure the new computer and deliver it to your office after it arrives.

**Create incidents and change requests from a requested item**

You can quickly open an incident or a change request from a requested item. It also maintains a relationship between the requested item, and its associated incidents or change requests.
The administrator must enable the **Create Change** and **Create Incident** UI actions for the Requested Item [sc_req_item] table. The administrator must set the **Active** field to `true` when editing these UI actions.

Role required: itil

1. Navigate to **Self-Service > Requested Items**.
2. Open a requested item.
3. Click the Additional actions menu icon and select **Create Change** or **Create Incident**

**View request status**

View the status of a request to see its progress, and determine when it may be fulfilled.

1. Navigate to **Self-Service > Requested Items**.
2. Click your order number to view details.
3. View the order's progress in the **Stage** field.

4. Check the **Backordered** field, and if the item is backordered, review comments for information about its return to stock.

**Customize homepages**

If you are assigned at least one role in the system, you can create a customized homepage that you can see when you log in.

The content on your homepage comes from a variety of sources, such as graphs and charts generated from a report, application modules, a service catalog category, the scrolling news widget, which is the News knowledge category.

1. Navigate to **Self-Service > Homepage**.
2.

Add any item to the homepage by clicking the add content icon ( ) or the Add content link at the top.

A window will open that lets you select from a number of different homepage items you can add. Some items pertain to specific features and applications, such as CMS content blocks and the Work Management dispatch map. So the list of items varies depending on what is active on your system.

3. Reposition elements on your homepage by dragging and dropping them to a new location.

4. To remove a homepage item, click the [X] on the right side of the item's header.

Delete custom homepages

You can delete any of your custom homepages if you no longer need them.

1. Click the Delete page link at the bottom of the homepage.

2. Click OK to confirm the deletion.

How Help the Help Desk identifies devices

Help the Help Desk uses a predefined series of queries to identify and update existing CIs in the CMDB or to create a new CI if no match is found.

These queries attempt to match devices using the three criteria listed here, in this order. Updates to an existing CI require only a single match as the list is evaluated. For example, if a device’s name has changed, but the MAC address is the same, the CI with the matching MAC address is updated.

- Serial number in the `cmdb_ci_computer` table
- MAC address in the `cmdb_ci_network_adapter` table
- Computer name in the `cmdb_ci_computer` table

Note: Discovery Identifiers are incompatible with Help the Help Desk queries.
Script Include

The script include `CIIdentifierForHelpDesk` provides the logic for updating existing CIs or creating a new CI if no matching device exists in the CMDB. Do not modify this script. Errors introduced into this script can result in update failures or in new CIs being created for every device found.

Running Help the Help Desk

Help the Help Desk is a tool that enables users to populate the CMDB automatically with information about their Windows computer. Help the Help Desk is a small Web application that downloads and runs locally, using a login script to gather information such as serial number, computer name, disk configuration, network configuration, installed software, memory, and much more.

To detect all system software successfully on a 64-bit machine, make sure to run the Help the Help Desk script from a 64-bit browser. A 64-bit browser can detect both 64-bit and 32-bit software, but a 32-bit browser cannot detect 64-bit software.

1. On your instance, navigate to Self Service > Help the Help Desk.
2. Click Start the Scan to Help the Help Desk.
   You are prompted to run or save the `discovery.hta` script.
3. If your browser is Internet Explorer, run the script. If you are using any other browser, click Save and save the script to the local machine.
4. To execute the saved script, double click the file.
   The script runs a series of WMI queries to gather information about the Windows machine. When it is done, the data is sent back to your ServiceNow instance and used to populate the configuration database (CMDB).

Service Delegation

Service delegation is the ability to designate other users to view and interact with approvals sent or tasks assigned to you, and to receive copies of all email notifications sent to you.

**Note:** Users to whom you delegate responsibility see all pending tasks and approvals regardless of the delegation period.

**Note:** Delegation does not cascade. When a user acts as a delegate for another user, the delegate cannot in turn delegate to a third party. The original delegate is the only user who receives assignments and notifications. Delegation does not grant the delegate access to tasks where the caller or requester is the user for whom the delegate was created.

Add the Delegates related list to a user profile

To delegate approvals and tasks to another user, configure your user profile form to display the Delegates related list.

Role required: personalize_form or admin.

1. Navigate to Self-Service > My Profile.
2. On the form context menu, navigate to Configure > Related Lists, and then add the Delegate->User related list.

The Delegates related list displays at the bottom of the user profile form.
Delegate approvals and tasks to another user

If a user is out of the office, that user can delegate responsibilities to other users for a period of time.

1. Navigate to Self Service > My Profile.
2. In the Delegates related list, click New.

Delegates related list

If the list is not visible, configure the form to add the Delegate->User related list.

3. Select the Delegate (User).
4. Set the period of time.
5. Specify the responsibilities the delegate will assume using the following check boxes. You can delegate:

- **Approvals**: The delegate can approve items on your behalf.
- **Assignments**: The delegate can view and work on tasks assigned to you.
- **CC notifications**: The delegate receives a copy of email notifications sent to you, except those marked as Meeting Invitation.

**Note:** If the Approvals check box is selected but CC notifications is not, the delegate does not receive approvals.

- **Meeting invitations**: The delegate receives a copy of email notifications sent of the type Meeting Invitation.

**Note:** You must select an active user as your delegate. The instance only delegates to active users. You can remove delegates from this list at any time.

A sample delegation looks like this:

![Delegate New record](image)

**Delegation options**

**Note:** If your delegate gets email notifications, they will be the same email notifications sent to you. The delegate may be confused to see “Incident assigned to you” emails, so make sure they know they are a delegate.
Service administration

Configure settings for services that support business applications or the platform.

Assessments

Use assessments to evaluate, score, and rank records from any table in the system.

You can assess projects that executives want to evaluate for effective management, or rate and compare a vendor's goods and services. Use assessments to send custom questionnaires to selected users or write scripts that query the database directly. You can then compare assessment results for the records using unique graphical views designed to highlight key performance information. Share an assessment between ServiceNow instances by using update sets, which is the recommended way to move assessment data from one instance to another.

The Assessments plugin is enabled by default.

You can only edit an assessment that has the same application scope as that of your current session.

Installed with Assessments

Several types of components are installed with activation of Assessments.

- Demo data is available for assessments and surveys.
- Vendor Performance offers an additional set of vendor assessment demo data.

Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description: Assessments</th>
<th>Description: Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessable Record</td>
<td>Stores all assessable records.</td>
<td>For system use only.</td>
</tr>
<tr>
<td>[asmt_assessable_record]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assessment Category Result</td>
<td>Stores all category results.</td>
<td>For system use only.</td>
</tr>
<tr>
<td>[asmt_category_result]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assessment Category User</td>
<td>Stores associations between users and metric categories they can assess. A user that is associated to a category is a category user.</td>
<td>Stores associations between users and surveys. A user that is associated to a survey is a survey user and is automatically associated to all the survey's categories.</td>
</tr>
<tr>
<td>[asmt_m2m_category_user]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assessment Group</td>
<td>Stores all assessment groups.</td>
<td>For system use only.</td>
</tr>
<tr>
<td>[asmt_assessment]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assessment Instance</td>
<td>Stores all assessment instances.</td>
<td>Stores all survey instances.</td>
</tr>
<tr>
<td>[asmt_assessment_instance]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description: Assessments</td>
<td>Description: Surveys</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assessment Instance Question [asmt_assessment_instance_question]</td>
<td>Stores all assessment instance questions, each of which represents one question on one assessment instance.</td>
<td>Stores all survey instance questions, each of which represents one question on one survey instance.</td>
</tr>
<tr>
<td>Assessment Metric [asmt_metric]</td>
<td>Stores all metrics.</td>
<td>Stores all survey questions.</td>
</tr>
<tr>
<td>Assessment Metric Definition [asmt_metric_definition]</td>
<td>Stores all metric definitions.</td>
<td>Stores all answer options for survey questions.</td>
</tr>
<tr>
<td>Assessment Metric Template [asmt_template]</td>
<td>Stores all metric templates.</td>
<td>Stores all question templates.</td>
</tr>
<tr>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Stores all metric types.</td>
<td>Stores all survey definitions.</td>
</tr>
<tr>
<td>Assessment Stakeholders [asmt_m2m_stakeholder]</td>
<td>Stores associations between assessable records and category users. A category user that is associated to an assessable record is a stakeholder.</td>
<td>Not used for surveys.</td>
</tr>
<tr>
<td>Assessment Template Definition [asmt_template_definition]</td>
<td>Stores all metric template definitions.</td>
<td>Stores all question template definitions.</td>
</tr>
<tr>
<td>Assessment X Category Matrix [asmt_m2m_xcategory_matrix]</td>
<td>Allows users to specify metric categories as the X axis of a decision matrix.</td>
<td>Not used for surveys.</td>
</tr>
<tr>
<td>Assessment Y Category Matrix [asmt_m2m_ycategory_matrix]</td>
<td>Allows users to specify metric categories as the Y axis of a decision matrix.</td>
<td>Not used for surveys.</td>
</tr>
<tr>
<td>Bubble Chart [asmt_bubble_chart]</td>
<td>Stores all bubble chart definitions.</td>
<td>Not used for surveys.</td>
</tr>
<tr>
<td>Category Assessable Records [asmt_m2m_category_assessment]</td>
<td>Stores associations between assessable records and metric categories.</td>
<td>For system use only.</td>
</tr>
<tr>
<td>Decision Matrix [asmt_decision_matrix]</td>
<td>Stores all decision matrices.</td>
<td>Not used for surveys.</td>
</tr>
<tr>
<td>Metric Category [asmt_metric_category]</td>
<td>Stores all metric categories.</td>
<td>Stores all survey categories.</td>
</tr>
<tr>
<td>Metric Result [asmt_metric_result]</td>
<td>Stores all metric results.</td>
<td>Stores all survey responses.</td>
</tr>
<tr>
<td>Signature [asmt_signature]</td>
<td>Stores all signature records for assessments and [[Attestations</td>
<td>GRC attestations]].</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2931
### Trigger Condition

<table>
<thead>
<tr>
<th>Table</th>
<th>Description: Assessments</th>
<th>Description: Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>asmt_condition</td>
<td>Stores all assessment trigger conditions.</td>
<td>Stores all survey trigger conditions.</td>
</tr>
</tbody>
</table>

### Properties

#### sn_portal_surveys.sp_survey.email_redirection

- **Description**: Allow a survey accessed from a link in an email to open in the Service Portal (applies only for surveys).
- **Type**: Yes/No
- **Default value**: no
- **Location**:
  - Assessments > Admin > Assessment Properties
  - Survey Management > Administration > Properties
- **Learn more**: Customize the appearance of a survey

#### com.snc.assessment.signature_authentication

- **Description**: Require authentication for user signature. When Yes is selected, this property requires credentials for a full name signature.
- **Type**: True/False
- **Default value**: true
- **Location**:
  - Assessments > Admin > Assessment Properties
  - Survey Management > Administration > Properties
- **Learn more**: Signatures

#### css.assessment.question.header.background.color

- **Description**: Sets the background color of question headers on assessment and survey questionnaires.
- **Type**: color
- **Default value**: #767676
- **Location**:
  - Assessments > Admin > Assessment Properties
  - Survey Management > Administration > Properties
- **Learn more**: Customize the appearance of a survey
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>css.assessment.caption.background.color</td>
<td>Sets the background color of the caption on assessment and survey questionnaires.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: color&lt;br&gt;• <strong>Default value</strong>: #eee&lt;br&gt;• <strong>Location</strong>:&lt;br&gt;• Assessments &gt; Admin &gt; Assessment Properties&lt;br&gt;• Survey Management &gt; Administration &gt; Properties&lt;br&gt;• Learn more: Customize the appearance of a survey</td>
</tr>
<tr>
<td>com.snc.assessment.decision_matrix_filter_max_entries</td>
<td>Maximum number of items to show for a decision matrix field filter.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: integer&lt;br&gt;• <strong>Default value</strong>: 1000&lt;br&gt;• <strong>Location</strong>:&lt;br&gt;• Assessments &gt; Admin &gt; Assessment Properties&lt;br&gt;• Survey Management &gt; Administration &gt; Properties&lt;br&gt;• Learn more: Customize the appearance of a survey</td>
</tr>
<tr>
<td>css.assessment.caption.font.color</td>
<td>Sets the font color of the caption text on assessment and survey questionnaires.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: color&lt;br&gt;• <strong>Default value</strong>: #ffffff&lt;br&gt;• <strong>Location</strong>:&lt;br&gt;• Assessments &gt; Admin &gt; Assessment Properties&lt;br&gt;• Survey Management &gt; Administration &gt; Properties&lt;br&gt;• Learn more: Customize the appearance of a survey</td>
</tr>
</tbody>
</table>
User roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>assessment administrator [assessment_admin]</td>
<td>Can administer the Assessments application. Can access all the modules of the Assessments application.</td>
<td>• None</td>
</tr>
</tbody>
</table>

Note: The assessment_admin role is contained by the itil_admin role. It is also contained by the survey_admin role.

Script includes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AssessmentUtils</td>
<td>Core code for assessment functionality.</td>
</tr>
<tr>
<td>AssessmentUtilsAJAX</td>
<td>AJAX based code for displaying scorecard data.</td>
</tr>
<tr>
<td>MigrateSurveyToAssessment</td>
<td>Code for migrating legacy surveys to assessment surveys.</td>
</tr>
<tr>
<td>RatingUtilsAJAX</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>SurveyUtils</td>
<td>Core code for survey functionality.</td>
</tr>
</tbody>
</table>

Client scripts

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Assessable Record Field choice list</td>
<td>Trigger Condition [asmt_condition]</td>
<td>Limits the Assessable Record Field choices to those that are compatible with the selected assessment.</td>
</tr>
<tr>
<td>Check survey schedule period</td>
<td>Trigger Condition [asmt_condition]</td>
<td>Checks the selected survey definition's Schedule period. If Schedule period is set to Only Once, this client script displays a warning message that each user can only take the selected survey once.</td>
</tr>
<tr>
<td>Clear display_when when depends changed</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Shows the Display when field when the Depends on field is set. Clears the Display when field when the Depends on field changes and the options need to change.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Conditionally Set Type for Surveys</td>
<td>Group [sys_user_group]</td>
<td>Sets the user group Type to survey if you create a new group from the User Groups module.</td>
</tr>
<tr>
<td>Data type -- Hide choices for surveys</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Ensures only Data type options that are valid for surveys are available on the Survey Question form.</td>
</tr>
<tr>
<td>Data type -- Show/Hide Not Applicable</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Hides the Allow not applicable field and sets its value to false if the metric method is Assessment and the data type is Percentage, Checkbox, Date, Date/Time, Number, or String.</td>
</tr>
<tr>
<td>Datatype defaults to String for surveys</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Sets the default Data type field value to String on the Survey Question form.</td>
</tr>
<tr>
<td>Fetch Min/Max</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Updates the Min and Max fields to match the least and greatest metric template definition values if an assessment administrator selects or changes the Template value.</td>
</tr>
<tr>
<td>Hide Assessable Record Field</td>
<td>Trigger Condition [asmt_condition]</td>
<td>Hides the Assessable Record field unless the evaluation method of the metric type selected in the Assessment field is Assessment.</td>
</tr>
<tr>
<td>Hide assessment if empty</td>
<td>Survey [survey_master]</td>
<td>Hides the Assessment field on the Survey form unless it contains a value. The system populates the Assessment field when you migrate a survey.</td>
</tr>
<tr>
<td>Hide Survey Instance Trigger ID if Empty</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
<td>Hides the Trigger ID field and makes it read-only unless it contains a value.</td>
</tr>
<tr>
<td>Hide user lists</td>
<td>Assessable Record [asmt_assessable_record]</td>
<td>Hides the Category users related list if the associated metric type schedule type is On demand.</td>
</tr>
<tr>
<td>Hide user related lists</td>
<td>Metric Category [asmt_metric_category]</td>
<td>Hides the User related list if the associated metric type schedule type is On demand and the Evaluation method is not Survey.</td>
</tr>
<tr>
<td>Hide value or String value</td>
<td>Assessment Instance Question [asmt_assessment_instance_question]</td>
<td>Hides the Value field and shows the String value field if the associated metric data type is Date, Date/Time, or String. Does the opposite if the data type is anything else.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Live feed deletion warning</td>
<td>Assessable Record [asmt_assessable_record]</td>
<td>Displays a warning message if an assessment administrator clears the Live feed check box.</td>
</tr>
<tr>
<td>Method -- Show/Hide Not Applicable</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Hides the Mandatory and Allow not applicable fields and sets both values to false if the metric method is Script. Shows the Mandatory field if the metric method is Assessment. Shows the Allow not applicable field if the method is Assessment except when the data type is Percentage, Checkbox, Date, Date/Time, Number, or String.</td>
</tr>
<tr>
<td>Min/Max Control</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Makes the Min and Max fields mandatory except when the data type is Template.</td>
</tr>
<tr>
<td>Min/Max Read-only</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Makes the Min and Max fields read-only when the data type is Choice or Likert Scale.</td>
</tr>
<tr>
<td>Populate Groups</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Populates the available values for the Filter field with fields from the selected metric type table.</td>
</tr>
<tr>
<td>Read only Type</td>
<td>Metric Category [asmt_metric_category]</td>
<td>Makes the Type field read-only when it contains a value.</td>
</tr>
<tr>
<td>Reload Decision Matrix Filter Columns</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Populates the available choices for the Default matrix filter as appropriate if the Filter field value changes.</td>
</tr>
<tr>
<td>Reload default filters</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Populates the available choices for the Default filter as appropriate if the Display all filters value changes.</td>
</tr>
<tr>
<td>Set scale factor</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Set table field</td>
<td>Metric Category [asmt_metric_category]</td>
<td>Sets the category Table value to that of the metric type.</td>
</tr>
<tr>
<td>Show and Hide Scheduled Job</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Hides the Scheduled job field if the Schedule type is On demand and shows the Scheduled job field if the Schedule type is Scheduled.</td>
</tr>
<tr>
<td>Show and Hide Scheduled Job Survey View</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Shows the Scheduled job field on the Survey Definition form if the Schedule period is Daily, Weekly, Monthly, or Yearly.</td>
</tr>
</tbody>
</table>
### ServiceNow DocVersion  Now Platform capabilities

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle Metric Definitions (Load)</td>
<td>Assessment Metric</td>
<td>Displays the Assessment Metric Definitions related list if the data type is Choice or Likert Scale.</td>
</tr>
<tr>
<td>Toggle Metric Definitions (Update)</td>
<td>Assessment Metric</td>
<td>Displays the Assessment Metric Definitions related list if the data type is Choice or Likert Scale. Sets the Method field to the appropriate value if the data type is compatible with one method only.</td>
</tr>
<tr>
<td>Update Min And Max Default Values</td>
<td>Assessment Metric</td>
<td>Sets reasonable default values for the Min and Max fields, based on the data type.</td>
</tr>
<tr>
<td>Validate Probability</td>
<td>Survey Trigger Condition</td>
<td>Ensures that the Probability (%) value is a whole number between 1 and 100.</td>
</tr>
<tr>
<td>Verify Max</td>
<td>Assessment Metric</td>
<td>Verifies that the Max value is greater than the Min value and greater than or equal to zero if the metric method is Assessment.</td>
</tr>
<tr>
<td>Verify Min</td>
<td>Assessment Metric</td>
<td>Verifies that the Min value is less than the Max value and greater than or equal to zero if the metric method is Assessment.</td>
</tr>
<tr>
<td>Verify Value</td>
<td>Assessment Metric Definition</td>
<td>Verifies that the Value is greater than or equal to zero.</td>
</tr>
<tr>
<td>Verify Value</td>
<td>Assessment Template Definition</td>
<td>Verifies that the Value is greater than or equal to zero.</td>
</tr>
</tbody>
</table>

### Business rules

#### Business rules for Assessments

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessable domain matches type</td>
<td>Assessable Record</td>
<td>Ensures that all new assessable records are in the same domain as the metric type. This is a special requirement of assessment domain separation, that all records must be in the same domain.</td>
</tr>
<tr>
<td>Auto stakeholder creation</td>
<td>Assessment Category User</td>
<td>Assigns new category users as stakeholders automatically for assessable records if the associated category has the Create stakeholders check box selected.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Auto stakeholder creation</td>
<td>Category Assessable Records</td>
<td>Creates stakeholders from all of a category's category users automatically for new assessable records if:</td>
</tr>
<tr>
<td></td>
<td>[asmt_m2m_category_assessment]</td>
<td>• The Create stakeholders check box is selected for the metric category.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The same metric category is associated to the new assessable record.</td>
</tr>
<tr>
<td>Auto stakeholder creation</td>
<td>Metric Category</td>
<td>Assigns all of a category's category users as stakeholders for each assessable record associated to the category when the Create stakeholders check box is selected for the category.</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric_category]</td>
<td></td>
</tr>
<tr>
<td>Calculate category max weight</td>
<td>Assessment Metric</td>
<td>Calculates the sum of all metric weights in a category.</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric]</td>
<td></td>
</tr>
<tr>
<td>Cancel notification workflow</td>
<td>Assessment Instance</td>
<td>Cancels the workflow that generates assessment email notifications when an assessment instance is deleted or changes state to Complete or Canceled.</td>
</tr>
<tr>
<td></td>
<td>[asmt_assessment_instance]</td>
<td></td>
</tr>
<tr>
<td>Category domain matches type</td>
<td>Metric Category</td>
<td>Ensures that all new categories are in the same domain as the metric type. This is a special requirement of assessment domain separation, that all records must be in the same domain.</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric_category]</td>
<td></td>
</tr>
<tr>
<td>Check Live Feed Groups</td>
<td>Assessable Record</td>
<td>Selects the Live feed check box if a live feed group is associated with the source record. If the Live feed check box is selected and no live feed group is associated with the source record, this business rule clears the check box.</td>
</tr>
<tr>
<td></td>
<td>[asmt_assessable_record]</td>
<td></td>
</tr>
<tr>
<td>Check only one default</td>
<td>Bubble Chart</td>
<td>Ensures there is only one default bubble chart for a metric type.</td>
</tr>
<tr>
<td></td>
<td>[asmt_bubble_chart]</td>
<td></td>
</tr>
<tr>
<td>Check only one default</td>
<td>Decision Matrix</td>
<td>Ensures there is only one default decision matrix for a metric type.</td>
</tr>
<tr>
<td></td>
<td>[asmt_decision_matrix]</td>
<td></td>
</tr>
<tr>
<td>Create actual results</td>
<td>Assessment Instance</td>
<td>Generates assessment and category results from the user responses if a user completes an assessment.</td>
</tr>
<tr>
<td></td>
<td>[asmt_assessment_instance]</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Create Business Rule on Remote table | Assessment Metric Type [asmt_metric_type] | Generates the following business rules if an assessment administrator creates or updates a metric type:  
- Business rule called Auto business rule for Assessments, which monitors the Table selected for the metric type. When someone adds a record that meets the metric type conditions, this business rule generates an assessable record. If someone changes the metric type's Table or conditions, the Create Business Rule on Remote table business rule updates the automatic business rule script to reflect the changes.  
- Business rule called Auto deletion rule for Assessments, which prevents users from deleting a record on the metric type's Table if the record is associated to metric or category results. If the record has no associated results and a user deletes it, this business rule deletes any associated assessable records.  

The Create Business Rule on Remote table business rule generates automatic business rules only for metric types with Evaluation method set to Assessment. |
| Create Scheduled Job | Assessment Metric Type [asmt_metric_type] | Assessments: Generates a scheduled job for the creation of assessment components if either of these conditions is met:  
- Someone creates a new metric type with the schedule type set to Scheduled.  
- The schedule type changes from On demand to Scheduled.  

Surveys: Generates a scheduled job for the creation of survey components if the schedule period for a survey definition is set to Daily, Weekly, Monthly, or Yearly. |
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Survey Records</td>
<td>Assessment Metric Type</td>
<td>Generates various records and populates certain fields on those records when someone creates a new survey definition, which is a metric type with Evaluation method set to Survey. More specifically, this business rule generates a survey category and assessable record, both associated to the survey definition.</td>
</tr>
<tr>
<td>Create UI Action on Remote table</td>
<td>Assessment Metric Type</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>decision_matrix_axis</td>
<td>Global</td>
<td>Limits available categories for X- and Y-axes to those that belong to the type if there is a metric type specified on the Decision Matrix form.</td>
</tr>
<tr>
<td>Delete Live Feed Group</td>
<td>Assessable Record</td>
<td>Deletes the assessable record's live feed group, if there is one, when an assessment administrator deletes an assessable record.</td>
</tr>
<tr>
<td>delete related users</td>
<td>Category Assessable Records</td>
<td>Deletes any stakeholders for the assessable record and category when an assessment administrator disassociates a category from an assessable record.</td>
</tr>
<tr>
<td>Do not allow category to change</td>
<td>Assessment Metric Type</td>
<td>Prevents the Category field from being changed if there are any conditional question dependencies related to the current record.</td>
</tr>
<tr>
<td>Do not allow datatype to change</td>
<td>Assessment Metric Type</td>
<td>Prevents the Data type and Template fields from being changed if there are any conditional questions that depend on the current record.</td>
</tr>
<tr>
<td>Ensure Types Match</td>
<td>Assessment Metric Type</td>
<td>Sets the type of a metric to the type of the associated category.</td>
</tr>
<tr>
<td>Ensure types match</td>
<td>Assessment Stakeholders</td>
<td>Ensures users can only create a stakeholder from a category user and assessable record of the same type.</td>
</tr>
<tr>
<td>Ensure types match</td>
<td>Category Assessable Records</td>
<td>Prevents users from associating categories of one type to an assessable record of a different type.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Evaluate filters</td>
<td>Assessable Record</td>
<td>Performs the following after the system generates a new assessable record:</td>
</tr>
<tr>
<td></td>
<td>[asmt_assessable_record]</td>
<td>• Checks all filter conditions for categories in the type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Automatically associates the new assessable record to all categories for which it meets the category filter conditions.</td>
</tr>
<tr>
<td>Generate assessment trigger condition</td>
<td>Trigger Condition</td>
<td>Generates a business rule the survey or assessment trigger condition uses to send surveys or assessments.</td>
</tr>
<tr>
<td></td>
<td>[asmt_condition]</td>
<td></td>
</tr>
<tr>
<td>getStakeholders</td>
<td>Global</td>
<td>Ensures that only category users for categories associated with the assessable record are available on the Assessable Record form when users edit the Category users related list.</td>
</tr>
<tr>
<td>Link assessable record and category</td>
<td>Metric Category</td>
<td>Sets these hidden fields as follows for a newly created survey category:</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric_category]</td>
<td>• Table: Assessment Metric Type [asmt_metric_type]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Filter: &lt;sys_id of the survey definition the new survey category is associated with&gt;</td>
</tr>
<tr>
<td>Live Feed Group</td>
<td>Assessable Record</td>
<td>Creates a live feed group for the assessable record, if one does not exist, when the record is saved with the Live feed check box selected.</td>
</tr>
<tr>
<td></td>
<td>[asmt_assessable_record]</td>
<td>If the check box is then cleared and the record saved, this business rule deletes an existing live feed group.</td>
</tr>
<tr>
<td>Metric domain matches category</td>
<td>Assessment Metric</td>
<td>Ensures that all new metrics are in the same domain as the category to which they belong. This is a special requirement of assessment domain separation, that all records must be in the same domain.</td>
</tr>
<tr>
<td></td>
<td>[asmt_metric]</td>
<td></td>
</tr>
<tr>
<td>Notify assessment user</td>
<td>Assessment Instance</td>
<td>Starts a workflow that sends an email notification to the assigned user when an assessment instance changes to the Ready state or the user to which it is assigned changes. The workflow generates other assessment email notifications at later stages.</td>
</tr>
<tr>
<td></td>
<td>[asmt_assessment_instance]</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Prevent recursive dependencies</td>
<td>Assessment Metric [asmt_metric]</td>
<td>Prevents the Depends on field from being set in a way that creates a recursive conditional question dependency.</td>
</tr>
<tr>
<td>Publish Survey</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Generates survey instances and assigns them to the associated survey users when the survey definition state changes from Draft to Published.</td>
</tr>
<tr>
<td>Remove auto create Business Rules</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Deletes the automatically created business rule for a metric type when an assessment administrator deletes that metric type.</td>
</tr>
<tr>
<td>Remove auto create UI Actions</td>
<td>Assessment Metric Type [asmt_metric_type]</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Remove auto created business rule</td>
<td>Survey Trigger Condition [asmt_condition]</td>
<td>Deletes the automatically created business rule when someone deletes the survey trigger condition.</td>
</tr>
</tbody>
</table>
| Remove Scheduled Job                            | Assessment Metric Type [asmt_metric_type]  | Assessments: Deletes the scheduled job for a metric type if either of these conditions is met:  
  • Someone deletes the metric type.  
  • Someone changes the schedule type from Scheduled to On demand.  
  Surveys: Deletes the scheduled job for a survey definition if the schedule period is set to Only Once or No Limit.  |
<p>| Reset Min/Max for metric                        | Assessment Metric Definition [asmt_metric_definition] | Updates the Min and Max fields for metrics and survey questions based on the metric definition Value.                                         |
| Set Domain for M2M Cat Assessable Recs          | Category Assessable Records [asmt_m2m_category_assessment] | Ensures that assessable records are only associated to categories in the same domain. This is a special requirement of assessment domain separation, that all records must be in the same domain. |
| Set Domain for M2M Category Users               | Assessment Category User [asmt_m2m_category_user] | Ensures that users are only linked to categories in the same domain. This is a special requirement of assessment domain separation, that all records must be in the same domain. |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Domain for M2M Stakeholders</td>
<td>Assessment Stakeholders</td>
<td>Ensures that assessable records are only linked to category users in the same domain. This is a special requirement of assessment domain separation, that all records must be in the same domain.</td>
</tr>
<tr>
<td>Set scratchpad fields</td>
<td>Assessment Metric Type</td>
<td>Caches field values for use by other scripts that run on the Assessment Metric Type form.</td>
</tr>
<tr>
<td>Store view type</td>
<td>Metric Category</td>
<td>Ensures that the Type field only allows users to select metric types used for assessments.</td>
</tr>
<tr>
<td>Synchronize category survey users</td>
<td>Assessment Category User</td>
<td>Ensures that the same users are associated with all of a survey's categories.</td>
</tr>
<tr>
<td>Synchronize survey users and stakeholder</td>
<td>Metric Category</td>
<td>Adds all users associated with a survey's existing categories to any newly created category for that survey.</td>
</tr>
<tr>
<td>Update Category Count</td>
<td>Assessment Metric</td>
<td>Updates the value in the Total metrics field on the Metric Category form when metrics are added to and deleted from the category.</td>
</tr>
<tr>
<td>Update records that match filter</td>
<td>Metric Category</td>
<td>Automatically performs these tasks when an assessment administrator edits the Filter field:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Associates the category to assessable records that meet the filter conditions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Disassociates the category from assessable records that do not meet the filter conditions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Assessable records related list reflects these changes when the record is saved.</td>
</tr>
<tr>
<td>Update scheduled job on schedule change</td>
<td>Assessment Metric Type</td>
<td>Updates the survey creation scheduled job to reflect schedule period changes.</td>
</tr>
<tr>
<td>Validate mandatory and not applicable</td>
<td>Assessment Metric</td>
<td>Sets the Mandatory and Allow not applicable fields to false if the metric method is Script. If the metric data type is Percentage, the business rule sets the Allow not applicable field to false.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Verify min/max</td>
<td>Assessment Metric</td>
<td>Ensures that the Min is greater than or equal to zero and less than the Max. Sets the Min to 0 and the Max to 1 if the data type is Checkbox or Yes/No.</td>
</tr>
</tbody>
</table>
| Verify value       | Assessment Template Definition             | Ensures that the metric template definition Value is:  
• Greater than or equal to zero.  
• Different from the Value for all other metric template definitions related to the template. |
| Verify value       | Assessment Metric Definition               | Ensures that users can only enter a metric definition Value greater than or equal to zero. Ensures that the metric definition Value is different from the Value for all other metric definitions related to the metric. |

**Assessment administrator tasks**

Before you create assessments, assign the assessment_admin role to the appropriate users in your organization and determine your objectives for the assessment.

Decide which sets of records in the system to assess, which themes you are interested in, and which traits to measure. Consider your organization’s options for obtaining the data to compare. If you intend to use assessment questionnaires, consider which people can answer the questions.

**Assessment terminology**

Assessment admins use several terms when working with assessments.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metric type</td>
<td>A metric type defines a set of records to evaluate, such as vendors, projects, or employees.</td>
</tr>
<tr>
<td>Assessable record</td>
<td>An assessable record links a record to evaluate, such as the company record for Amazon or the user record for a sales representative, to a metric type, such as vendors or employees. You define sets of assessable records when you create metric types.</td>
</tr>
<tr>
<td>Metric category</td>
<td>A metric category represents a theme for evaluating assessable records. Categories contain one or more individual metrics, which define specific traits or values that comprise the theme. Examples of categories include overall vendor performance or quality of delivery services. You can also set filter conditions that control which assessable records to evaluate for the metrics in a category.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Metric</td>
<td>A <em>metric</em> is a trait or value used to evaluate assessable records. A metric can measure subjective values in an assessment questionnaire, or gather objective values in a database query run by a script. Examples of metrics include perceived courtesy of sales representatives or number of incidents per vendor.</td>
</tr>
<tr>
<td>Category user</td>
<td>A <em>category user</em> is a person who knows about a specific category. One person can be a category user for multiple categories. Examples of category users include a vendor manager who oversees all purchasing operations or a supervisor of a sales team.</td>
</tr>
<tr>
<td>Stakeholder</td>
<td>A <em>stakeholder</em> is a category user who knows about a specific assessable record. Examples of stakeholders include a vendor manager who coordinates purchases from Amazon or a supervisor of a sales team who manages a specific employee.</td>
</tr>
<tr>
<td>Assessment instance</td>
<td>An <em>assessment instance</em> represents one assessment questionnaire assigned to one user. The system generates a new assessment instance for each assigned user when: • The assessment generation scheduled job runs. • An assessment administrator creates an on-demand assessment.</td>
</tr>
<tr>
<td>Scorecard</td>
<td>A <em>scorecard</em> provides a visual illustration of an assessable record's performance, based on assessment results. Use scorecards to view a variety of data summaries for one assessable record and to compare the ratings with other assessable records.</td>
</tr>
<tr>
<td>Decision matrix</td>
<td>A <em>decision matrix</em> is a graph with two axes that plots the assessment results for multiple assessable records. Use decision matrixes to determine the relative standing of assessable records in selected categories.</td>
</tr>
<tr>
<td>Bubble chart</td>
<td>A <em>bubble chart</em> is a graph with three axes that plots the assessment results for multiple assessable records. Use bubble charts to determine the relative standing of assessable records in selected categories, with an emphasis on one category.</td>
</tr>
</tbody>
</table>

**Assessment roles**

The Assessments application requires certain roles to perform assessment tasks. No role is required to take assessment questionnaires that are assigned to you.
## Assessment methods

The available methods are **Assessment**, for non-scripted metrics, and **Script**, for scripted metrics. Each method serves a different function and can be used with certain data types.

Use the **Method** field to specify how to use the metric.

### Assessment method

Metrics with the Method set to Assessment are called non-scripted metrics. Use each non-scripted metric to define a question for assessment questionnaires. Non-scripted metrics are useful if you want to obtain subjective data like personal opinions.

You can use the Assessment method with these **Data type** values:
• Attachment
• Checkbox
• Choice
• Date
• Date/Time
• Likert Scale
• Number
• Percentage
• String
• Template
• Yes/No

Script method

Metrics with the Method set to Script are called scripted metrics. Use each scripted metric to define a custom script for database queries. Scripted metrics are useful if your system contains reliable data for the traits you want to evaluate.

You can use the Script method with these Data type values:
• Duration
• Number
• Percentage

Use the Script field to write JavaScript code. By default, the field contains information about available variables and an example, which you can use as the basis of your script or replace entirely:

Metric form script field

You must use the following variables in your script:
• **primary**: Input variable used to access the sys_id of the record being assessed.
• **actual_result**: Output variable that contains the actual value for this metric. The system uses this variable to populate the Actual value field on the Metric Result form. For each actual_result, you must specify a corresponding scaled_result value.
• **scaled_result**: Output variable that contains a numerical scaled value to represent an actual value. The system uses this variable to populate the Scaled value field on the Metric Result form. Ensure the scaled values you specify are between or equal to the Min and Max values for the metric. The Scale definition field determines how the system uses the scaled value. A scale definition of Low means
smaller numbers are better, such as for a metric that measures the number of incidents for a vendor. **High** means larger numbers are better, such as for a metric that measures user satisfaction on a scale of one to five.

**Script example**

The metric Number of active devices uses the script pictured below. The *primary* variable is used to find CIs that are associated to the vendor record being assessed. The script retrieves the actual_result, the number of CIs associated to the vendor, then calculates the correct scaled_result. The script uses a series of scaled values, from the **Min** to the **Max** value, to represent actual values. Because the **Scale definition** is set to **High**, the greatest scaled values are best, meaning a vendor associated to the most CIs scores highest. The system stores the actual and scaled values in a metric result record for the vendor.

**Data types for assessments**

Metric data types have functions that depend on the method that you select.
### Assessment data types

<table>
<thead>
<tr>
<th>Data type</th>
<th>Compatible methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Assessment</td>
<td>On questionnaires, users attach one or more files to a question.</td>
</tr>
<tr>
<td>Checkbox</td>
<td>Assessment</td>
<td>On questionnaires, users select a check box next to a statement or leave it cleared. Set the Scale definition field to High if a selected check box equates to a good score.</td>
</tr>
<tr>
<td>Choice</td>
<td>Assessment</td>
<td>On questionnaires, users select a value from a list of custom answer options. Create a metric definition for each answer option.</td>
</tr>
<tr>
<td>Data type</td>
<td>Compatible methods</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Date</td>
<td>Assessment</td>
<td>On questionnaires, users select a date.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Assessment</td>
<td>On questionnaires, users select a date and time.</td>
</tr>
</tbody>
</table>
| Data type    | Compatible methods | Description                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                 |}
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Script</td>
<td>When the script runs, the system populates the <strong>Duration value</strong> and <strong>Scaled value</strong> fields on the Metric Result form with the appropriate values from the <code>actual_result</code> and <code>scaled_result</code> variables in the metric script.</td>
</tr>
<tr>
<td>Likert Scale</td>
<td>Assessment</td>
<td>On questionnaires, users select a value from a custom scale of answer options. Create a metric definition for each answer option, which is represented by a radio button on the scale. A Likert scale metric that evaluates an application’s ease of use might have the metric definitions <strong>Easy</strong>, <strong>Average</strong>, and <strong>Difficult</strong>. If you want to reuse a series of answer options for multiple metrics, create a metric template and use the Template data type instead of the Likert Scale data type.</td>
</tr>
<tr>
<td>Number</td>
<td>Assessment, Script</td>
<td><strong>Assessment</strong>: On questionnaires, users enter a number. <strong>Script</strong>: When the script runs, the system populates the <strong>Actual value</strong> and <strong>Scaled value</strong> fields on the Metric Result form with the appropriate values from the <code>actual_result</code> and <code>scaled_result</code> variables in the metric script.</td>
</tr>
<tr>
<td>Data type</td>
<td>Compatible methods</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Percentage| Assessment, Script | **Assessment** On questionnaires, users enter a number.  
Approximately what percent of the time are your incidents resolved in a week or less?  
\( \% \)  

**Script** When the script runs, the system populates the **Actual value** and **Scaled value** fields on the Metric Result form with the appropriate values from the actual_result and scaled_result variables in the metric script. |
<table>
<thead>
<tr>
<th>Data type</th>
<th>Compatible methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Assessment</td>
<td>On questionnaires, users enter text. The size of the string field depends on the String option you select:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="Image" alt="String single line wide data type" /></td>
</tr>
<tr>
<td>Template</td>
<td>Assessment</td>
<td>On questionnaires, users select a value from a predefined series of answer options. There must be at least one template defined to use this data type. For a template, there is a template definition for each answer option, which is represented by a radio button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="Image" alt="Template" /></td>
</tr>
</tbody>
</table>
### Data type

<table>
<thead>
<tr>
<th>Data type</th>
<th>Compatible methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes/No</td>
<td>Assessment</td>
<td>On questionnaires, users select Yes or No from a list. Set the Scale definition field to High if selecting Yes equates to a better score.</td>
</tr>
</tbody>
</table>

### Configure an assessment

Configure an assessment to evaluate, score, and rank records from any table in the system.

**Role required:** admin, survey_creator, or assessment_admin

1. Navigate to **Assessments > Metric Definition > Types**.
2. Click **New**.
3. Enter the field information.

**Note:** This field is displayed only when Service Portal is installed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the assessment.</td>
</tr>
<tr>
<td>Assessment duration</td>
<td>Allowed duration to complete an assignment after its generation.</td>
</tr>
<tr>
<td>Live feed</td>
<td>Checkbox that automatically creates live feed groups for newly generated assessable records of this type.</td>
</tr>
<tr>
<td>Notify manager if overdue</td>
<td>Checkbox to send a notification to the manager when the assessment becomes overdue.</td>
</tr>
<tr>
<td>Scale factor</td>
<td>Scale value for all assessment results.</td>
</tr>
</tbody>
</table>
| Pagination setting for Service Portal view | The setting on which the pagination is based for desktop or tablet view in Service Portal.  
  - Category: default  
  - Question: 1 question per page (automatic for mobile)  
  - None: no pagination |

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business rule</td>
<td>Business rule that is automatically created for assessable record generation.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assessors</td>
<td>User field from the table specified in the <strong>Conditions</strong> tab. The assessment will be assigned to all users of this user field in the table. When you save the assessment and click <strong>Generate Assessable Records</strong>, an assessable record is created for each unique user of the user field. This is applicable for Scheduled and On-demand assessments. For an on-demand assessment, each assessor assesses all assessable records. For a scheduled assessment, each assessor assesses only the corresponding assessable record.</td>
</tr>
</tbody>
</table>

**Related Links**

<table>
<thead>
<tr>
<th>Generate Assessable Records</th>
<th>Creates assessable records for this metric type.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Benchmarks</td>
<td>Opens the Benchmarks Dashboard that provides visibility into your key performance indicators (KPIs) and trends.</td>
</tr>
</tbody>
</table>

**Note:**
- This related link is available only for `survey_admin`, `assessment_admin`, and `survey_reader` with `bm_viewer` role.
- You must opt in to Benchmarks to view the dashboard. See Enable Benchmarks.
- This is applicable only for a published survey.

<table>
<thead>
<tr>
<th>Create Improvement Initiative</th>
<th>Opens the Improvement Initiative window to create an improvement initiative record that helps in improving the performance of the assessment.</th>
</tr>
</thead>
</table>

**Note:**
- This related link is available only for the `survey_admin` and `assessment_admin` role. A `survey_reader` can only view the created improvement initiative records.
- You should activate the Continual Improvement Management plugin (`com.sn_cim`).

**Related Lists**

<table>
<thead>
<tr>
<th>Metric Categories</th>
<th>All metric categories for this assessment.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessable Records</td>
<td>All assessable records for this assessment.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improvement Initiatives</td>
<td>Displays improvement initiatives associated with the survey.</td>
</tr>
</tbody>
</table>

- **Note:** This related list is available only when there is at least one improvement initiative record.

### Assessment generation

In the Assessments application, administrators or assessment administrators can trigger the system to generate scheduled assessments or on-demand assessments when all the prerequisite steps are completed.

An assessment administrator must publish the metric type to enable assessment generation.

The following tasks are performed when assessments are generated:

- Creates assessment questionnaires from non-scripted metrics and assigns the questionnaires to users. When users complete their assigned questionnaires, the system uses their responses to calculate assessment results.
- Runs scripted metrics from each category to query the database and calculate assessment results.

Each time the system generates assessments, it creates some or all of the following components. Consider having an administrator set a schedule for recurring data cleanup, as the system can potentially generate a considerable amount of assessment data.

- Assessment group
- Assessment instances
- Assessment results

### Assessment groups

An assessment group is a container for assessment instances and assessment results generated in a single occurrence.

The system generates an assessment group every time the scheduled job runs or the API is called, when there is at least one assessable record associated to a category in the type. You can find assessment group records in **Assessments > Assessment Groups**.

The Assessment Group form displays the group **Number**, the associated **Metric type**, and these related lists:

- **Assessment Instances**: Lists all assessment instances within this group. There may be no records in this related list. The system does not generate assessment instances if there are only scripted metrics for the type.
- **Metric Results**: Lists all metric results for this group. There may be no records in this related list initially. The system generates metric results immediately for scripted metrics, but not for non-scripted metrics, which appear as questions on assessments and require user response. The system dynamically updates the records in this list as users complete assessment questionnaires.
- **Assessment Category Results**: Lists all category results for this group. There may be no records in this related list initially. The system generates category results immediately if there are only scripted metrics in a category. Otherwise, the system does not calculate category results until a user completes an assessment questionnaire that contains questions from the category.
**Note:** To prevent the loss of important assessment data, you cannot delete an assessment group if it contains any assessment instances, metric results, or category results.

View an assessment metric category

View assessment metric categories that are used with assessment metric types and assessment metrics in generating the bubble charts on the Demand Workbench. The bubble charts help the demand managers to visually assess the demands.

Role required: it_pps_admin

The Demand Management application comes with an assessment metric type named Demand, five default assessment metric categories, and assessment metrics.

1. Navigate to **Project Administration > Settings > Assessments Metric Categories**.
2. Open an assessment metric category to review it.

The following default assessment metric categories are available with the Demand Management.

<table>
<thead>
<tr>
<th>Assessment metric category</th>
<th>Data source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>T-Shirt size field on the Demand form.</td>
<td>Assesses demand size relative to the size of other demands.</td>
</tr>
<tr>
<td>Strategic Alignment</td>
<td>Rating field in the assessment category result for the Strategic Alignment metric category.</td>
<td>Assesses how closely the demand aligns with strategic goals of the organization compared to other demands.</td>
</tr>
<tr>
<td>Risk</td>
<td>Rating field in the assessment category result for the Risk metric category.</td>
<td>Assesses demand risks compared to other demands.</td>
</tr>
<tr>
<td>ROI</td>
<td>Impact and Financial return fields on the Demand form.</td>
<td>Assesses demand return on investment compared to other demands.</td>
</tr>
<tr>
<td>Cost</td>
<td>Labor costs, Capital expense, and Operating expense fields on the Demand form.</td>
<td>Assesses demand cost compared to other demands.</td>
</tr>
</tbody>
</table>

Assessment metric categories

In the Assessments application, a metric category represents a theme for evaluating assessable records in a given metric type.

Each category has a numeric weight value to indicate its importance relative to other categories. Within a category, records called metrics are the traits or values used to evaluate assessable records. For example, there are many categories within the Vendor metric type, including Support Rating, which contains metrics that measure the quality of vendors' customer support services. Assessable records must be associated to categories to be eligible for evaluation. Assessment administrators create categories and manage which assessable records each category is associated to.

Weight categories and metrics

When you create a metric category or metric, you must specify a weight, a numeric value that indicates the importance of the category or metric relative to other categories and metrics.
The greater the weight value, the more important the item is. The system uses weight values in assessment result calculations. Consider these recommendations when choosing weight values.

- Determine a weighting scale and use it consistently. In general, use a scale with a small numeric range. A standard 1-10 scale is usually appropriate, where 1 is least and 10 most important. Understand that increasing the maximum value of a weighting scale impacts all related result calculations.
- Use the same weighting scale for metric categories and metrics. Though there is no limitation, consider using the same or very similar weighting scales for both categories and metrics to make it easier to remember which values to use. A scale of 1-10 is an effective and simple weighting system, but may not be suitable for all organizations.

**Note:** If you do not want to use weighting, set the same weight value for all categories and metrics. The default weight value is 10.

Create a category for assessable records
After you create a metric type and generate assessable records, create categories for the themes you are interested in using to evaluate the assessable records.

Role required: none

1. Navigate to **Assessments > Metric Definition > Categories**.
2. Click **New** to create a new metric category and then complete the Metric Category form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the metric category. The name appears on assessment questionnaires.</td>
</tr>
<tr>
<td>Type</td>
<td>[Required] Metric type this category is used for. Metrics in this category can be used to evaluate assessable records for the type you select. This field becomes read-only after you save the record.</td>
</tr>
<tr>
<td>Create stakeholders</td>
<td>Check box that enables (selected) or disables (cleared) automatic stakeholder creation for this category. When the check box is selected, the system makes all associated category users stakeholders for each assessable record associated to this category. This saves the time required to manually create stakeholders. For more information, see Create Stakeholders Automatically. Existing stakeholders are not impacted if you clear the check box.</td>
</tr>
<tr>
<td>Table</td>
<td>[Read-Only] Table that contains the records to evaluate with metrics in this category. The system automatically populates this field with the same table as the metric type selected. The table does not appear in the field until you save the form. This field is visible depending on whether a <strong>Type</strong> is selected.</td>
</tr>
<tr>
<td>Weight</td>
<td>[Required] Numerical value that represents the importance of this category relative to other categories. A greater value indicates greater importance. For more information, see weight categories and metrics. The default value is 10.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scoring type</td>
<td>Scoring method for an attestation category. This field appears only when the metric type is an attestation with a <strong>Scoring type of Percent</strong>. Use this field to configure different scoring types for specific attestation categories. Possible selections are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Percent</strong>: Attestation score as a weighted percentage of correct answers for scored questions.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All or nothing</strong>: All answers for attestation type questions must be correct or the score is zero for the entire category.</td>
</tr>
<tr>
<td>Total metrics</td>
<td>[Read-Only] Number of metrics associated to this category.</td>
</tr>
<tr>
<td>Filter</td>
<td>Filter conditions that assessable records must meet to be evaluated using metrics in this category.</td>
</tr>
<tr>
<td></td>
<td>The filter operates on fields on the selected table.</td>
</tr>
<tr>
<td></td>
<td>If you specify a filter condition, the system automatically associates matching assessable records to the category when you save the record. If you change the filter conditions, the system removes and creates assessable record associations as needed. The system also deletes stakeholders for assessable records it disassociates. The system does not remove assessable record associations created by users, even if the assessable records do not match the filter conditions.</td>
</tr>
<tr>
<td></td>
<td>This field is visible only when a <strong>Type</strong> is selected.</td>
</tr>
<tr>
<td>Description</td>
<td>Descriptive information about the category that appears on assessment questionnaires.</td>
</tr>
<tr>
<td>Roles</td>
<td>Only those users with the specified roles can perform the assessment for this category. If no role is specified, then users with any role can perform the assessment for this category.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: If the <strong>Roles</strong> property does not appear on the form, ask your admin to add the property.</td>
</tr>
<tr>
<td>Details</td>
<td>Text field containing an HTML editor. Use this field to present important details about this category to assessment recipients. Details can include formatted lists, images, videos, or links to external websites. You may need to configure the form to see this field.</td>
</tr>
<tr>
<td>Related Lists</td>
<td></td>
</tr>
<tr>
<td>Assessment Metrics</td>
<td>All metrics associated to this category. There must be at least one metric associated to the category to use any assessments with the category.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assessable records</td>
<td>All assessable records associated to this category. There must be at least one assessable record associated to the category to use any assessments with the category. This related list is hidden if the <strong>Evaluation method</strong> is <strong>Attestation</strong>.</td>
</tr>
<tr>
<td>Note: Category users are automatically generated based on the user field is specified in the <strong>Assessors</strong> tab of the assessment after publishing the assessment.</td>
<td></td>
</tr>
<tr>
<td>Users</td>
<td>All users associated to this category. There must be at least one category user to create scheduled assessments using metrics in this category. If any user field is specified in the <strong>Assessors</strong> tab of the assessment, the corresponding users are automatically generated after publishing the assignment. This related list is available only when the associated metric type has schedule type set to <strong>Scheduled</strong>. Category users are not a part of the on-demand assessment process.</td>
</tr>
</tbody>
</table>

Assessable record associations

Only the assessable records associated to a category can be evaluated using metrics in that category. Manage which assessable records you evaluate for each category by creating and removing the associations.

Only the assessable records associated to a category can be evaluated using metrics in that category. Manage which assessable records you evaluate for each category by creating and removing the associations.

**Note:** You can also manage which categories an assessable record is associated to using the Assessable Record form.

Manage an assessable record automatically

You must define at least one filter condition in the Metric Category form to automatically associate assessable records with the category.

Role required: assessment_admin or admin

1. Navigate to **Assessments > Metric Definition > Categories**.
2. Open a category.
3. In the **Filter** field, create a condition statement that defines the records you want to associate to this category. The available fields are from the table defined for the metric type.

   For example, for a category in the **Vendor** type, you might create the condition `[Country] [is] [Germany]`. Metrics in the category will be used only to evaluate vendors that meet this condition.

4. Save the record.

   The system associates this category to all assessable records that match the filter condition. As the system generates new assessable records that match the condition, it associates them to this category.
category. If you change the filter condition, the system removes and creates assessable record associations, as appropriate. Note the following:

- The system does not remove assessable record associations created manually, even if the assessable records do not match the filter conditions.
- The system deletes any related stakeholders, if applicable, when it disassociates assessable records from a category.
- The system does not create or remove assessable record associations if the related source records change. For example, consider the previous example in which all assessable records for vendors based in Germany were associated to a particular category. Assume that a user changes the **Country** of one of the vendor records from **Germany** to **Canada**. The system does not disassociate the related assessable record from the category, even though it no longer matches the filter condition.

**Note:** To configure the system to automatically associate all assessable records from a metric type to a category, use the same category condition as the metric type condition. For example, if the **Vendor** metric type has the condition `[Vendor] [is] [true]`, create the same condition for the category. If the metric type does not have a condition specified, you can use the category condition `[Sys ID] [is not empty]`, which includes all records from any table.

Manage an assessable record manually
You can manually create and remove assessable record associations for a category using a related list on the Metric Category form.

Role required: assessment_admin or admin

Keep in mind that when you disassociate an assessable record from a category, the system deletes any related stakeholders, if applicable, and you can no longer evaluate the assessable record using metrics in that category.

1. Navigate to **Assessments > Metric Definition > Categories**.
2. Open a category.
3. In the **Assessable records** related list, click **Edit** and use the slushbucket to add or remove one or more assessable records.

   Only assessable records associated to this category's metric type are available for selection.

Delete a category
When you delete a category, the system also deletes the associated category users and stakeholders.

Role required: assessment_admin or admin

1. Navigate to **Assessments > Metric Definition > Categories**.

   Alternatively, navigate to a record that contains a related list for categories.

2. Open a record from the list.
3. On the Metric Category form, click **Delete**.
4. Click **OK** when asked to confirm the action.

   The system displays messages at the top of the form describing the actions taken.

**Assessment metrics**
In the Assessments application, a metric is a trait or value used to evaluate assessable records.

Depending on the metric method, a metric can be used as either of the following:

- A question on assessment questionnaires, to obtain a subjective value such as how much people enjoy using each cell phone offered in the service catalog.
• A script that queries the database, to obtain an objective value such as the number of incidents related to each cell phone.

Each metric is associated to one metric category and can be used to evaluate assessable records for that category only. For example, the Support Rating category contains metrics that measure the quality of vendors’ customer support services. One metric addresses the quality of product documentation. Others address the strength of the user community, self-service options, online training, and other support services. Each metric has a numeric weight value to indicate its importance relative to other metrics in the same category.

Assessment administrators can create and administer metrics and metric templates, which define reusable sets of answer options for metrics used as assessment questions. If you decide to use metric templates, you may want to create them before you create metrics.

**Note:** Changes to assessment metrics and metric templates are reflected in assessment questionnaires and results, even if users have saved responses already. If possible, avoid changing the original meaning of a metric question, the data type, or any metric templates in use by existing assessments.

Create a metric for a category

After you create a category, create metrics you can use to evaluate the assessable records for that category.

Role required: assessment_admin or admin

When you create metrics, consider the focus of the category and what characteristics you want to measure for the items you will assess.

1. Navigate in one of the following ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asssessments &gt; Metric Definition &gt; Categories</td>
<td>Open a category, and locate the Assessment Metrics related list.</td>
</tr>
<tr>
<td></td>
<td>This is the suggested navigation path, as the system links metrics to the category from which they are created.</td>
</tr>
<tr>
<td>Asssessments &gt; Metric Definition &gt; Metrics</td>
<td></td>
</tr>
</tbody>
</table>

2. Click New.

3. Fill in the fields, as appropriate.

**Assessment Metric form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the metric.</td>
</tr>
<tr>
<td>Category</td>
<td>Metric category that the metric belongs to. The system automatically populates this category if you create a new metric from the Metric Category form.</td>
</tr>
</tbody>
</table>

**Note:** You cannot change the category if the Depends on field is set or if another metric depends on this metric.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>Determines how to use the metric.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Assessment</strong>: Non-scripted metric. Make the metric available as a question on an assessment questionnaire. The <strong>Assessment</strong> method is compatible with all data types except <strong>Duration</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Script</strong>: Scripted metric. Obtain values by writing a custom script. The <strong>Script</strong> method is compatible with the <strong>Duration</strong>, <strong>Number</strong>, and <strong>Percentage</strong> data types.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default answer from field</strong>: This option appears only if you have selected an <strong>Assessment Metric Type</strong> that contains a table. The <strong>General</strong> tab adds two fields:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default answer</strong>: Select the default answer for the question. The list comes from the selected table.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Ask question</strong>: Specifies when to ask the question: always or only if the default answer is empty.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default answer from script</strong>: The <strong>General</strong> tab adds a field:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Ask question</strong>: Specifies when to ask the question: always or only if the script does not contain a default answer. The script is defined on the <strong>Field Type</strong> tab.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you select a <strong>Data type</strong> that is incompatible with the selected <strong>Method</strong>, the system automatically changes the <strong>Method</strong> to the correct value.</td>
</tr>
<tr>
<td>Weight</td>
<td>Numeric value that represents the importance of this metric relative to other metrics in the same category. By default, the weight is 10. For weighting suggestions, see <strong>Weight Metrics and Metric Categories</strong>.</td>
</tr>
<tr>
<td></td>
<td>This field is visible and required unless the <strong>Data type</strong> is <strong>Date</strong>, <strong>Date/Time</strong>, or <strong>String</strong>. These data types are not included in results calculations.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Order</td>
<td>Numeric value that determines the order of the metric question on assessment questionnaires, relative to other metric questions in the same category. The metric with the smallest order value appears as the first question in the category section. By default, the order is 100. For more information about questionnaire layout, see <a href="#">Complete Assessment Questionnaires</a>.</td>
</tr>
</tbody>
</table>

**Note:** It does not matter which order value you use for metrics with the Script method, as they do not appear on questionnaires.

| Active | Check box that determines whether this metric is used to gather assessment results. If a non-scripted metric (Assessment method) is inactive, the question does not appear on assessment questionnaires generated after the metric becomes inactive. If a scripted metric (Script method) is inactive, the script does not run. |

| Mandatory | Check box that makes the metric question mandatory (selected) or optional (cleared) on assessment questionnaires. Users cannot submit questionnaires until they provide valid responses to all mandatory questions, which display a red field status indicator.  
This field is visible only if the **Method** is Assessment, the **Depends on** field is empty, and the data type is not Checkbox. |
### Field: Allow not applicable

Check box that determines whether to include a **Not Applicable** answer option for this metric question on assessment questionnaires. Users can select **Not Applicable** if they do not have sufficient information to respond to a question or if a question does not apply to a particular assessable record. User responses of **Not Applicable** are excluded from results calculations.

This field is visible only if the **Method** is **Assessment** and certain data types are selected.

### Additional fields you can add by customizing the form

#### Details

Text field containing an HTML editor. Use this field to present important details about this metric to assessment recipients. Details can include formatted lists, images, videos, or links to external websites.

*What type of men's trousers are expressly forbidden by company policy?*

Female employees may mark this question "Not Applicable."
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Text to use as the question on assessment questionnaires. Enter a clear, straightforward question that is easy to answer, such as <strong>How likely are you to recommend this vendor for the purchase of office supplies?</strong></td>
</tr>
<tr>
<td>Description</td>
<td>Information about the metric and what it evaluates. If the <strong>Method</strong> is <strong>Assessment</strong>, include details that help users understand how to answer the question. This text appears as a hint when a user points to the question text on the questionnaire.</td>
</tr>
<tr>
<td>Depends on</td>
<td>Setting used to make this metric a conditional question. Select an existing metric question from the list, which displays <strong>Checkbox</strong>, <strong>Choice</strong>, <strong>Likert Scale</strong>, <strong>Template</strong>, and <strong>Yes/No</strong> metrics of the same category as this metric. Then, use the <strong>Displayed when</strong> field to set the conditions that display this metric question on questionnaires. The system prevents the creation of recursive dependencies between metrics. For example, if Metric A depends on Metric B, Metric B cannot depend on Metric A. This field is visible only if the <strong>Method</strong> is <strong>Assessment</strong>.</td>
</tr>
<tr>
<td>Displayed when</td>
<td>Answer options for the selected <strong>Depends on</strong> metric question that, when chosen on questionnaires, display this metric question. This field is visible and required only if the <strong>Depends on</strong> field is set.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Data type</td>
<td>[Required] Format of the expected response data. The function of the data type depends on the selected Method. If the method is Assessment, the data type determines how users answer the corresponding question on questionnaires. If the method is Script, the data type determines how the system calculates assessment results.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If another metric depends on this metric, you cannot change the data type.</td>
</tr>
<tr>
<td>Randomize answers</td>
<td>Check box that determines whether to present the answer options for this metric question in a random order. The order of answer options can influence users, which creates biased results. Randomizing answer options can help prevent this bias.</td>
</tr>
<tr>
<td></td>
<td>This field is visible only if a data type that requires metric definitions is selected.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Randomizing answer options for certain questions can make those questions confusing for the person answering. In general, only randomize answer options that do not follow a logical order. For example, the following question is confusing when randomization is enabled:</td>
</tr>
<tr>
<td>Template</td>
<td>Metric template to use for the metric question. A metric template is a set of predefined answer options. This field is visible and required only if the Data type is Template.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If another metric depends on this metric, you cannot change the template.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dependent plugin</td>
<td>Plugin that contains the tables queried in the script. The system executes the metric script only if the plugin is active. The default available values are Asset Management, CMDB, Core, Cost Management, Procurement, and Software Asset Management. If the Method is Script, select a plugin. This field is visible only if the Method is Script.</td>
</tr>
<tr>
<td>Note:</td>
<td>An administrator may need to add more choices of plugins to the field.</td>
</tr>
<tr>
<td>Scale definition</td>
<td>Setting that determines whether lesser or greater numerical values equate to a good score in assessment result calculations. Select <strong>Low</strong> if lesser numerical values are better, such as for a metric that measures the number of incidents for a vendor. Select <strong>High</strong> if greater numerical values are better, such as for a metric that measures user satisfaction on a scale of one to five. The default value is <strong>High</strong>. This field is visible and required unless the Data type is Date, Date/Time, or String. The results for these data types are not included in results calculations.</td>
</tr>
<tr>
<td>Note:</td>
<td>For information about how to set the scale definition for data types that do not require you to set a numerical value, see Data Types.</td>
</tr>
<tr>
<td>Min</td>
<td>Lowest numerical value to be used as an answer option on assessments or as a scaled value in a scripted metric. This field is visible and required only if certain data types are selected. If the data type is Choice or Likert Scale, this field is read-only and is set automatically based on the smallest metric definition Value.</td>
</tr>
<tr>
<td>Max</td>
<td>Highest numerical value to be used as an answer option or scaled value. This field is visible and required only if certain data types are selected. If the data type is Choice or Likert Scale, this field is read-only and is set automatically based on the largest metric definition Value.</td>
</tr>
<tr>
<td>Script</td>
<td>Script that obtains the desired system information. This field is visible and required only if the Method is Script. For more information about using this field, see Script methods.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Related List</td>
<td></td>
</tr>
<tr>
<td>Assessment Metric Definitions</td>
<td>Lists all metric definitions, which appear as answer options for questions on assessment questionnaires. Click <strong>New</strong> to create a new metric definition. This related list is available only if the Data type is <strong>Choice</strong> or <strong>Likert Scale</strong>.</td>
</tr>
</tbody>
</table>

4. **Save the record.**

   When you create a **Choice** or **Likert Scale** question, reopen the Assessment Metric form after you submit it to create a metric definition. If you distribute a questionnaire without creating the answers for questions with these data types, recipients are unable to answer the questions. If the questions are mandatory, the recipients are unable to submit their questionnaires.

**Create a metric definition**

Metrics with Choice or Likert Scale data types must have metric definitions defined to represent answer options on questionnaires.

**Role required:** assessment_admin or admin

Each metric definition appears as one answer option for a question on an assessment questionnaire. For example, a metric for the question "How satisfied are you with the quality of this vendor?" has three metric definitions to create these answer options: **Very satisfied**, **Somewhat satisfied**, and **Not at all satisfied**.

1. Open the metric record you want to edit.
2. In the **Assessment Metric Definitions** related list, click **New** to create a new metric definition.
3. Fill in the fields:
   - **Display:** Enter the text you want to appear as the answer option.
   - **Value:** Enter the numeric value, greater than or equal to zero, to which the answer option equates. Values are used to calculate metric results. When you view assessment questions, metric definitions appear in order from least to greatest value.
     - The system sets the minimum and maximum values according to the metric definition values.
     - To prevent reporting confusion, no two metric definitions for a given metric should have the same Value.
4. Click **Submit**.

**Change the order of an answer**

By default, the order of answer options is established when a question is created with a data type of **Choice** or **Likert Scale**.

**Role required:** assessment_admin or admin

The system creates an Order value for each choice based on where it appears in the original list when you submit it. This order corresponds to the **Value** setting you give the answer. The choice with the lowest order number appears first, and the choice with the highest order number appears last. If you want to reconfigure the order of the answer options, you must do so by editing the **Order** field and not the **Value** field.
The **Order** column is hidden in the base system.

To edit these records, configure the **Assessment Metric Definitions** related list in the question record to show the **Order** column, and then edit the order number in the list. The **Value** setting remain the same for each answer option after reorganization.

---

**Metric types and assessable records**

In the Assessments application, assessment administrators create and administer metric types and assessable records.

A metric type defines a set of records an organization wants to evaluate, such as vendors, projects, or employees. For each type, the system generates unique assessable records that link the type to records that need to be evaluated, such as the individual records for the vendors Amazon and Intel. There may be multiple assessable records for the same source record if the source record meets the criteria for more than one type. For example, you might want to evaluate a record on the Company table, such as Intel, as a vendor and as a manufacturer, with different categories and metrics.

For configuration suggestions, see Assessment administrator tasks.

---

**Assessable records**

An assessable record links a source record you want to evaluate, such as the company record for Amazon or the user record for a sales representative, to a metric type, such as vendors or employees.

You use assessments to evaluate the assessable record. The system generates assessable records from the source records that match the table and conditions set on the Assessment Metric Type form. You evaluate the assessable records with metric categories and metrics, which define traits and values to assess. For metric types with the **On demand** schedule type, you can generate on-demand assessments from the Assessable Record form. This method of assessment generation makes it easy to create and preview short questionnaires or to quickly obtain assessment results for specific assessable records.

You can set up an assessment description that includes information from multiple fields on an assessable record and is displayed on multiple lines. This set up provides the user who is taking the assessment with a more detailed and understandable description of the information being requested on the assessment questionnaire. Create a multi-line description using table titles, which can be defined to use one or more fields from the selected table. See Customize the mobile list title for more information.

---

**Create metric types and generate assessable records**

Each metric type sets a table and filter conditions that define a set of records to evaluate.

**Role required:** assessment_admin or admin

For example, the Vendor Performance application provides the **Vendor** metric type, which defines an assessable record for each source record in the Company [core_company] table that has the **Vendor** field.
selected. Create a metric type for each set of records you want to evaluate, such as vendors, users within an organization, or projects.

In addition to defining assessable records, metric types also determine how to filter decision matrix data and set the schedule type, which determines whether assessments are on-demand or scheduled.

1. Navigate to **Assessments > Metric Definition > Types**.
2. Click **New**.
3. Fill in the fields, as appropriate (see table).
4. When you are satisfied with the type settings, click **Generate Assessable Records** under **Related Links** to save the record and create assessable records.

The page redirects to the list of assessable records created. The system is now set up to create an assessable record each time a new matching record is created.

**Attention:** Clicking **Generate Assessable Records** can trigger the deletion of existing assessable records under certain circumstances. For more information, see **Enforce a condition to delete an assessable record**.

### Metric types

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Required] Name of the type. It may be practical to give the type a name that indicates which records it defines.</td>
</tr>
<tr>
<td>Assessment duration</td>
<td>Amount of time assessors have to complete their assigned questionnaires, starting from the time the assessment is generated. The assessment duration sets the <strong>Due date</strong> that appears on assessment instances. Changes made to the duration of an attestation in the GRC Control Test Definition form are updated dynamically in this field. The default duration is 14 days.</td>
</tr>
<tr>
<td>Live feed</td>
<td>Check box that determines whether to enable (selected) or disable (cleared) the Live Feed view in scorecards for all assessable records created from this type.</td>
</tr>
<tr>
<td>Notify manager if overdue</td>
<td>Check box that determines whether to send (selected) email notifications a user's manager when that user fails to submit an assigned questionnaire on time.</td>
</tr>
<tr>
<td>Assessment manager</td>
<td>Manager for this assessment metric type. These users are responsible only for managing the assessment process and not the results. The system notifies the assessment manager when an assessment for this metric type is past due.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Scoring type</strong></td>
<td>Scoring method to use for questions with a data type of attestation. The possible selections are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Percent</strong>: Attestation score as a weighted percentage of correct answers for scored questions. When you select this scoring type, categories can be scored as <strong>Percent</strong> or <strong>All or nothing</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All or nothing</strong>: Requires all answers for attestation type questions to be correct, or the score is zero for the entire attestation. When you select this scoring type, all categories are scored automatically as <strong>All or nothing</strong>.</td>
</tr>
<tr>
<td><strong>Scale factor</strong></td>
<td>[Required] Number to represent the best possible score for assessment results. All results for assessments of this type are scaled to this number. 10 is generally a good scale factor.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field becomes read-only when it contains a value and you save the metric type. Choose a scale factor you are satisfied with before you save the metric type.</td>
</tr>
<tr>
<td><strong>Pagination setting for Service Portal view</strong></td>
<td>Specify how the user will see pages on the desktop or tablet view in Service Portal.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Category</strong>: Display each category on a separate page. The categories appear in the following order:</td>
</tr>
<tr>
<td></td>
<td>• Each category appears in sequence on a separate page for the first assessable record</td>
</tr>
<tr>
<td></td>
<td>• Then each category appears in sequence on a separate page for the next assessable record</td>
</tr>
<tr>
<td></td>
<td>• and so on</td>
</tr>
<tr>
<td></td>
<td>• <strong>Question</strong>: Display each question on a separate page. Questions appear on separate pages for mobile devices regardless of this setting. Each question appears for each category as described for the <strong>Category</strong> setting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong>: All items on a single page—no pagination</td>
</tr>
<tr>
<td><strong>Default</strong>: <strong>Category</strong></td>
<td><strong>Note</strong>: This field appears only when Service Portal is installed.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Roles</td>
<td>Additional user roles that can view the results and access records associated with this type. Users with the specified roles have read access to this type record as well as to associated categories, metrics, assessable records and scorecards, category users, stakeholders, and decision matrixes. Note: Users with these roles do not have access to Assessments modules unless they are also assessment administrators. Users with these roles can navigate to the records by other means, such as from reference fields on assessment instances. This field provides the option to easily grant certain users access to specific assessment data in special cases. For example, the Vendor metric type provides access to users with the vendor_manager role so they can view results and compare assessable records when they open scorecards or decision matrixes in the Vendor Performance application.</td>
</tr>
<tr>
<td>Signature</td>
<td>[Optional] Acknowledgement by a survey recipient of requirements, admonitions, or expectations related to an assessment. For more information, see Create an assessment signature.</td>
</tr>
<tr>
<td>Return URL</td>
<td>Destination address of a web page that is presented to users after they submit an assessment for this metric type. When a return URL is configured, the end note content does not appear.</td>
</tr>
<tr>
<td>State</td>
<td>[Read-Only] Status of the assessment: Draft or Published.</td>
</tr>
<tr>
<td>Business rule</td>
<td>[Admin only] Business rule the system creates to monitor the specified table. When a new record is added to the table that meets the metric type conditions, the business rule generates a corresponding assessable record. If someone changes the table or conditions of the metric type, the system updates the business rule to reflect the changes. Existing assessable records associated with the metric type are not affected.</td>
</tr>
<tr>
<td>Schedule type</td>
<td>Setting that determines which assessment process to use. Select On demand or Scheduled.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scheduled job</td>
<td>[Admin only] Scheduled job the system creates to generate assessments for this metric type. This field is populated the first time you save the record. The scheduled job name follows the format &lt;type name&gt; Assessment Creation. Administrators can configure a recurring assessment generation schedule for the metric type. This field is visible only when the schedule type is Scheduled.</td>
</tr>
</tbody>
</table>
| Evaluation method   | [Admin only] Indicates the evaluation method for this metric type. The system sets this field based on how the metric type is created. The possible evaluation methods are:  
  • Assessment: Default filter value for metric types. Only this evaluation method uses assessable records, conditions, and stakeholders.  
  • Attestation: For details, see Attestations - Legacy.  
  • Survey: For details, see Survey definitions. |
| Scale factor        | [Required] Number to represent the best possible score for assessment results. All results for assessments of this type are scaled to this number. 10 is generally a good scale factor. |
| Allow retake        | Check box that allows users to modify their answers to a completed assessment, quiz, survey, or attestation. After the due date, the system removes the assessment from the user's My Assessments and Surveys page. |
| Active              | Check box that determines whether the metric type is active. When the metric type is inactive (cleared), assessment generation is disabled and users cannot take existing assessments. |
| Description         | Helpful information about this type. Enter a clear description of the type and its purpose. |

**Note:** If you change the schedule type from Scheduled to On demand, the system deletes the scheduled job. If you change the schedule type back to Scheduled, the system creates a new scheduled job. The previous assessment generation schedule is not saved, but can be reconfigured if desired.

**Note:** This field becomes read-only when it contains a value and you save the metric type. Choose a scale factor that you are satisfied with before you save the metric type.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>Introductory content to display on assessment questionnaires. Consider adding a company logo, a welcome message, background information about the survey, or instructions. You may need to configure the form to see this field.</td>
</tr>
<tr>
<td>End note</td>
<td>Content to display on the screen that appears when someone submits an assessment questionnaire. Consider adding a thank you message, followup instructions, or other applicable information. You may need to configure the form to see this field. End notes are not displayed if a Return URL is specified.</td>
</tr>
<tr>
<td>Send notifications</td>
<td>Select the check box to send notifications for this assessment, survey, or attestation. You may need to configure the form to see this field. End notes are not displayed if a Return URL is specified.</td>
</tr>
<tr>
<td>Condition section</td>
<td>[Required] Table that contains the records you want to evaluate. The system creates assessable records for records on this table that meet the conditions you specify, if any. The number of matching records appears as a link by the Condition field. The link dynamically updates if you change the table selection. Click the link to open the list of matching records in a new tab or window.</td>
</tr>
<tr>
<td>Note:</td>
<td>Additional roles are required to view the records on certain tables. If you select a table that you do not have access to, a warning message appears by the Condition field where the number of matching records would be. You cannot generate assessable records for tables you do not have sufficient roles for.</td>
</tr>
<tr>
<td>Enforce condition</td>
<td>Check box that determines what happens to assessable records when you change the selected table or conditions.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition builder that defines specific records to assess from the selected table. If you do not specify any conditions, the system creates assessable records for all records on the selected table. Click the refresh icon to update the adjacent record count.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you change the table or conditions, you must click Generate Assessable Records to create new assessable records.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Decision Matrix section</strong></td>
<td></td>
</tr>
</tbody>
</table>
| **Filter field**         | [Required] Field on the selected table that can be used to filter results on decision matrixes and scorecards. For example, if the selected table is Company[core_company] and you choose Vendor type as the filter field:  
  - When you view decision matrixes for this type, the decision matrix menu to filter plotted items lists vendor types: Applications, Hardware, Services, and Software.  
  - On scorecards for this type, the Averages view displays ratings by vendor type.                                                                                                                                                                                                 |
| **Filter condition**     | Condition builder that defines which records from the table are available as choices on the filter menu. For example, if the filter field is Vendor type and you create the filter condition [Name] [does not contain] [Hardware], only records with vendor types of Applications, Services, and Software are possible choices as decision matrix filters. |
Field | Description
--- | ---
Default matrix filter | Record to use as the default filter choice on decision matrixes and scorecards. The selected Filter field and Filter condition control the available record choices. To see the records, if any, click the refresh icon next to the field. Consider the case that the filter field is Vendor type and you select Applications as the default matrix filter. The filter choice on decision matrixes for this type is set to Applications by default. If you change the value of the Table or Filter condition field, you must click the refresh icon to view the updated Default matrix filter choices. If you do not, the system selects the first available choice from the updated field choices when you save the record.

Related Lists

Metric Categories | All metric categories associated with the type.
Assessable Records | All assessable records associated with the type. This related list is hidden in the Attestation view of this form.

**Note:** The Generate Assessments button is visible to administrators in certain cases for scheduled assessments. Do not click the button until after completing the prerequisite tasks.

Delete a metric type

Deleting a metric type entails deleting many related records.

Role required: assessment_admin or admin

You must delete some of these records manually before deleting the type, while the system deletes others automatically with the type.

1. Delete the records associated with the type to delete:
   - Assessment results (metric and category results)
   - Assessment instance (questions and assessment instances, in that order)
   - Assessment groups

2. Delete the type.
   - A confirmation dialog box appears and alerts you that certain records associated with the type will also be deleted.
3. Click **OK** to delete the type and these related records:
   - Scheduled job for assessment generation
   - Business rule for assessable record generation
   - Assessable records
   - Metric categories
   - Category users
   - Stakeholders
   - Metrics
   - Metric definitions
   - Decision matrixes

Export an assessment
You can share assessments between ServiceNow instances by exporting an assessment and then importing the assessment on another instance.

**Role required:** assessment_admin or admin

**Note:** Update sets are available in the Helsinki release and should be used to move data from one instance to another. For information about update sets, see System update sets.

**Note:** The system exports a single XML file that does not contain result data.

The XML file contains a metric type `[asmt_metric_type]` and the following records that are associated with the type:
- Assessable records `[asmt_assessable_record]`
- Metric categories `[asmt_metric_category]`
- Metrics `[asmt_metric]`
- Metric definitions `[asmt_metric_definition]`
- Category users `[asmt_m2m_category_user]`
- Stakeholders `[asmt_m2m_stakeholder]`
- Decision matrices `[asmt_decision_matrix]`, `[asmt_m2m_xcategory_matrix]`, and `[asmt_m2m_ycategory_matrix]`

1. Navigate to **Assessments** > **Metric Definition** > **Types**.
2. Right-click the record and select **Export Assessment**.
3. Save the XML file.

Import an assessment
Share assessments between ServiceNow instances by importing a previously exported assessment.

**Role required:** admin

**Note:** Update sets are available in the Helsinki release and should be used to move data from one instance to another. For information about update sets, see System update sets.

1. Ensure that the target instance has assessments enabled.
2. Follow the procedure detailed in **Import a Record as XML Data**.

Use update sets for surveys and assessments
Use an update set to capture changes to surveys and assessments.

**Role required:** admin or survey_admin
When developing surveys and assessments, you can use an update set to capture the changes and move them from a development instance to a production instance. Once an update set is created and marked current, all of the updates to the following tables are recorded in the update set.

The following tables are now update set enabled and also extend the application file:

- Assessment Metric Templates [asmt_template]
- Assessment Template Definitions [asmt_template_definition]
- Assessment Metric Definitions [asmt_metric_definition]: survey question answer options
- Schedule [sys_trigger]: scheduled jobs associated with the survey
- Assessment Metric Categories [asmt_metric_category]: survey categories
- Assessment Metrics [asmt_metric]: survey questions
- Assessment Category Users [asmt_m2m_category_user]: survey users
- Trigger Conditions [asmt_condition]

Create an assessment signature

A signature on an assessment questionnaire contains assertions that can communicate directions, a legal statement, or any text that you want the recipient to consider.

Role required: assessment_admin or admin

You can require the recipient to select a check box or provide a full signature to acknowledge acceptance of the assertion before submitting the form. You can display assertions without requiring a signature. An assessment property called Require authentication for user signature allows you to require users to provide their user name and password when an assessment asks for a full name signature.

1. Navigate to Assessments > Metric Definition > Signatures.
   All signatures in the system appear in this list.
2. Click New.
3. Complete and submit the form using the fields in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for this signature</td>
</tr>
<tr>
<td>Signature type</td>
<td>Type of signature required. The selections are Checkbox, Full name, or Assertion only. If Assertion only is selected, no signature is required to submit the questionnaire. By default, the system requires user authentication for a full name entry.</td>
</tr>
<tr>
<td>Assertion</td>
<td>Text to present to recipients that requires acknowledgement.</td>
</tr>
</tbody>
</table>

Assessable records

An assessable record links a source record you want to evaluate, such as the company record for Amazon or the user record for a sales representative, to a metric type, such as vendors or employees.

You use assessments to evaluate the assessable record. The system generates assessable records from the source records that match the table and conditions set on the Assessment Metric Type form. You evaluate the assessable records with metric categories and metrics, which define traits and values to assess. For metric types with the On demand schedule type, you can generate on-demand assessments from the Assessable Record form. This method of assessment generation makes it easy to create and preview short questionnaires or to quickly obtain assessment results for specific assessable records.
You can set up an assessment description that includes information from multiple fields on an assessable record and is displayed on multiple lines. This provides the user who is taking the assessment with a more detailed and understandable description of the information being requested on the assessment questionnaire. Create a multi-line description using table titles, which can be defined to use one or more fields from the selected table. See Customize the mobile list title for more information.

View an assessable record

View the Assessable Record form to edit preferences and perform various actions.

Role required: assessment_admin or admin

1. Navigate to Assesments > Assessable Records.
2. Open a record from the list.
   By default, the list displays only assessable records with Active metric types.
3. On the Assessable Record form, edit fields and perform other actions as necessary (see table).

Viewing Assessable Records

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Read-Only] Assessable record name based on the display value of the source record. The name appears on assessment questionnaires.</td>
</tr>
<tr>
<td>Source</td>
<td>[Read-Only] Source record the assessable record is linked to. The Source reflects the table name and source record display value. For example, if the Name field is the display value for the Company table, the assessable record for a company record named Amazon has the Source value Company: Amazon.</td>
</tr>
<tr>
<td>Live feed</td>
<td>Check box that, when selected, creates a live feed group for the assessable record, which appears on the scorecard. If you clear the check box after a live feed group has been created, the system deletes the live feed group and all its messages.</td>
</tr>
<tr>
<td>Type</td>
<td>[Read-Only] Metric type from which the assessable record was generated.</td>
</tr>
<tr>
<td>Decision matrix</td>
<td>Check box that, when selected, enables this assessable record's results data to appear on decision matrixes of the same metric type. Decision matrixes are graphs that plot the assessment results for multiple assessable records. If you clear the check box, the assessable record still appears on the default decision matrixes if you click the View Matrix related link on the assessable record's scorecard.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Live feed group</td>
<td>[Read-Only] Live feed group for this assessable record. When you select the <strong>Live feed</strong> check box and save the record, the system populates this field.</td>
</tr>
</tbody>
</table>

### Related Links

- **View Scorecard**: Opens the scorecard for the assessable record.

### Related Lists

- **Category**: All metric categories associated with the assessable record. An assessable record must be associated to a category to be evaluated. Click **Edit** to add or remove category associations. Note that it is often more efficient to **associate assessable records** to categories using the Metric Category form.

- **Category users**: All stakeholders who can take assessment questionnaires about this assessable record. Click **Edit** to create and delete stakeholders. For more information about this and other methods of creating stakeholders, see **Stakeholders**. This related list is available only when the associated metric type has the **Scheduled** schedule type.

---

**Enforce a condition to delete an assessable record**

By default, the system does not delete assessable records, even if you change the table or conditions for the type and the existing assessable records no longer match.

**Role required**: assessment_admin or admin

The system can be configured so you can trigger the deletion of assessable records that do not match the type table and conditions.

1. On the Assessment Metric Type form, select the **Enforce condition** check box to enable deletion of existing assessable records of this type that do not match the table or conditions specified.

   When the check box is cleared, the system retains existing assessable records of this type, even if they do not match the table and conditions specified.

2. Click **Generate Assessable Records** to delete all assessable records associated with the type that do not match the current table and conditions.

The system does not automatically delete assessable records, even if the **Enforce condition** check box is selected. You must click **Generate Assessable Records** with the check box selected every time you want the system to delete non-matching assessable records.

**Delete an assessable record**

When you delete an assessable record, the system deletes any stakeholders for the record.

**Role required**: assessment_admin or admin
Add a metric category and metric in the question bank for assessments

Reuse the question categories (metric categories) and questions (metrics) added in the question bank for assessments. You can add metric categories or metrics from the question bank to an assessment, or from the assessment to a question bank.

Role required: admin or assessment_admin

1. Navigate to Assessments > Question Bank.
2. Click New.
3. In the Metric Category form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the metric category.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the metric category.</td>
</tr>
<tr>
<td>Total metrics</td>
<td>Total number of metrics in the metric category.</td>
</tr>
<tr>
<td></td>
<td>This number is automatically updated when you add or delete metrics from</td>
</tr>
<tr>
<td></td>
<td>the category.</td>
</tr>
</tbody>
</table>

4. Right-click on the title bar and click Save.
5. In the Assessment Metrics related list, click New.
6. In the Assessment Metric form, fill the fields. For more information on assessment metric fields, refer to Create a metric for a category.
7. Click Submit.

Configure metric categories or metrics for an assessment using the question bank

Reuse question categories (metric categories) and questions (metrics) from the Question Bank module while creating or updating an assessment.

Role required: admin or assessment_admin

1. Navigate to Assessments > Metric Definitions > Types.
2. Open an assessment definition.
3. Optional: To add metric categories to an assessment from the question bank in Platform, perform the following steps.
   a) In the Metric Categories related list, click New Category from Bank.
      The New Category from Bank dialog box is displayed with a list of all metric categories added in the question bank.
   b) Select the required categories and click Add Selected.
      A copy of the metric category and the corresponding metrics is created in the Metric Categories related list.
4. Optional: To add metrics to an assessment from the question bank in Platform, perform the following steps.
a) In the Metric Categories related list, open a metric category definition.

b) In the Assessment Metrics related list, click **New Metric from Bank**.
The New Metric from Bank dialog box is displayed with a list of questions available in the question bank.

c) Select the required metrics and click **Add Selected**.
A copy of the metric and the corresponding metric definitions is created in the Assessment Metrics related list of the category.

5. Optional: To add a metric category to the question bank from an assessment in Platform, perform the following steps.
   a) In the Metric Categories related list, open a metric category definition.
   b) Click **Add to Question Bank**.
   A copy of the category is created along with its metrics and metric definitions in the question bank.

6. Optional: To add a metric to the question bank from an assessment in Platform, perform the following steps.
   a) In the Metric Categories related list, open a metric category definition.
   b) In the Assessment Metrics related list, open the required metric definition.
   c) Click **Add to Question Bank**.
The Add to Question Bank dialog box is displayed.
   d) In the **Choose a question bank to add this question/metric** field, select a metric category that you want to add this metric to, and click **OK**.
A copy of the metric and the corresponding metric definitions is created for the selected category in the question bank.

**Copy an assessment**

Create a copy of an assessment with at least one category to reduce the effort of creating another assessment with similar data.

Role required: assessment_admin or admin

All associated questions (type), configurations, categories, metrics, domain separation rules, and role-based categories are copied. Assigned users, category users, instances, and trigger conditions are not copied.

1. Navigate to **Assessments > Metric Definition > Types**.
2. Select an assessment metric type.
3. In the title bar, click **Copy**, or click the menu icon, and select **Copy**.

**Create a metric template**

Create a metric template to define reusable rating scales for evaluating non-scripted metrics.

Role required: assessment_admin or admin

1. Navigate to **Assessments > Metric Definition > Templates**.
2. Click **New**.
3. Fill in the **Name** field on the Assessment Metric Template form.
4. To use images for template choices, such as for image scale questions, select **Allow Image**.
5. Click **Submit**.
6. Under the **Assessment Template Definitions** related list, click **New**.
Create a template definition for each answer option you want to appear on an assessment question.

7. Fill in the following fields:
   - **Display**: Enter the text to appear as the answer option.
   - **Value**: Enter a numeric value, equal to or greater than zero, that you want the answer option to equate to. Values are used in results calculations.
   - **Selected Image**: Click to add the image to use for selected state.
   - **Unselected Image**: Click to add the image to use for unselected state.

   When you view assessment questions that use templates, answer options appear in order from least to greatest Value.

   **Tip**: To prevent reporting confusion, no two template definitions for a given template should have the same Value.

8. Click **Update**.

**Metric templates**
Metric templates define reusable rating scales for evaluating non-scripted metrics.

Each answer option on the scale is defined as a template definition, much like a metric definition. For example, the metric template named Satisfaction contains the template definitions: **Very Satisfied**, **Satisfied**, **Neutral**, **Dissatisfied**, and **Very Dissatisfied**.

Metric templates are available for metrics that have **Template** as the Data type. The following metric templates are available by default:

<table>
<thead>
<tr>
<th>Name</th>
<th>Assessment template definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Likert 5</td>
<td>Strongly Disagree, Disagree, Neutral, Agree, Strongly Agree</td>
</tr>
<tr>
<td>Satisfaction</td>
<td>Very Dissatisfied, Dissatisfied, Neutral, Satisfied, Very Satisfied</td>
</tr>
<tr>
<td>Frequency</td>
<td>Never, Seldom, Sometimes, Most of the time, All of the time</td>
</tr>
<tr>
<td>Amount</td>
<td>None, Few or little, Average amount, Many, Quite a lot</td>
</tr>
<tr>
<td>Size</td>
<td>Very Small, Small, Average, Large, Very Large</td>
</tr>
<tr>
<td>Quality</td>
<td>Very Poor, Poor, Average, Good, Very Good</td>
</tr>
<tr>
<td>Complexity</td>
<td>Very Complex, Complex, Moderate, Simple, Very Simple</td>
</tr>
</tbody>
</table>

**Update a metric minimum and maximum value to match a template**
For assessment results to be properly calculated, the Min and Max values of a metric that uses a template must be equal to the smallest and largest template definition Value, respectively.

Role required: assessment_admin or admin

The system sets the **Min** and **Max** fields automatically when you create a metric of the Template data type, based on the template definition values. However, the system does not update these fields for existing metrics if you add a new template definition to a template or if you update the Value of an existing template definition. If the new Value is less than the minimum value of any metrics that use the template or greater than the maximum value, update the metrics accordingly.
To edit the minimum and maximum values for a question that has the Template data type:

1. Navigate to **Assessments > Metric Definition > Metrics**.
2. Configure the list to show the **Min** and **Max** columns.
3. Run the following list filter condition: `[Template] [is] [select the template you updated]`
4. Ensure the Min and Max values match the smallest and largest template definition Value for the selected template, respectively.

If the values do not match, edit the Min and Max directly from the list.

**Note:** When the data type is Template, a UI policy prevents the editing of Min and Max from the form.

**Category users and stakeholders**

Users who take assessments are individuals in your organization who have specific knowledge of the assessment categories and the records being assessed. A person who is qualified to answer assessment questions from metrics in a specific category becomes a category user when associated to that category. A category user then becomes a stakeholder when associated to a specific assessable record.

The system determines which assessable records and questions a user receives by looking at the metric categories and assessable records for which those users are stakeholders. Assessment administrators can create and manage category users and stakeholders.

**Note:** Category users and stakeholders are used only for scheduled assessments.

**Category users**

Category users are users who can potentially answer assessment questions about a particular metric category for scheduled assessments. Category users should have special knowledge of the categories and the metrics those categories contain. A category user becomes a stakeholder when associated to an assessable record. Create at least one category user for each category you want to use for assessment questionnaires. There is no need for category users if the category contains only scripted metrics.

**Stakeholders**

A stakeholder is a category user with specific product or service knowledge, who is associated to an assessable record. A stakeholder is familiar with the assessable record and all the metrics within a specific category. The same category user can be associated to multiple assessable records, in which case the system creates a stakeholder record for each association.

There are multiple ways to create stakeholders:

- Configure the system to create stakeholders automatically.
- Associate multiple category users to multiple assessable records.
- Associate multiple category users to one assessable record.
- Associate one category user to one assessable record.

**Note:** Ensure you establish the desired user and assessable record associations to categories before attempting to creating stakeholders.

**Create a category user**

Create category users by associating users in the system to metric categories.
Role required: assessment_admin or admin

When you create category users, choose users who are knowledgeable and can answer questions from that category. For example, a purchasing agent is a good category user for metrics that evaluate a vendor's discount practices.

1. Navigate to **Assessments > Metric Definitions > Categories**.
2. Open a category record.

   ![Note: The category must be associated to a metric type that has the Schedule type set to Scheduled.]

3. In the **Users** related list, click **Edit**.
4. Select the appropriate users for this category.

**Create stakeholders automatically**

You can configure the system to create stakeholders automatically from all category users and assessable records associated with a category using the **Create stakeholders** check box on the Metric Category form.

Role required: assessment_admin or admin

If you associate a user to the category, the system makes the resulting category user a stakeholder for all the assessable records associated to the category. Similarly, if you associate a new assessable record to the category, the system makes all category users stakeholders for that record if they are not already stakeholders.

   ![Note: Use the Create stakeholders check box with caution. You can end up with more stakeholders than you want and a large amount of unnecessary assessment data. Automatic stakeholder creation is best suited to assessment implementations in which category users are knowledgeable about all or most of the assessable records associated to each category.]

1. Navigate to **Assessments > Metric Definition > Categories**.
2. Select a category.
3. Associate category users and assessable records to the category.
4. Select the **Create stakeholders** check box.
5. Click **Update**.
   
   All the category users are associated to all the assessable records as stakeholders.
6. In the **Assessable Records** related list, click **Edit**.
7. Using the slushbucket, associate an assessable record to the category.
8. Click **Save**.
   The system makes all category users stakeholders for the new assessable record.

9. Delete stakeholders as needed.

   **Associate multiple category users to multiple assessable records**
   The stakeholder list helper in the create stakeholders module is the most efficient way to associate multiple
category users to multiple assessable records in a single interface.

   Role required: assessment_admin or admin

   You can select category users from one category at a time.
Note: You cannot edit or delete stakeholders using the list helper.

1. Navigate to Assessments > Advanced > Create Stakeholders.
The stakeholder list helper appears.

2. Select a metric type from the list of available types.

Note: Only metric types for scheduled assessments are available. On-demand assessments do not use category users or stakeholders.

3. Select a category from the list of available categories.

Note: Only categories within the selected metric type are available.

The system populates the Category User and Assessable Records lists with category users and assessable records associated to the selected category.

4. Select one or more category users from the Category Users list.

5. Select one or more assessable records from the Assessable Records list.

6. Click the Associate arrow between the lists to complete the association.

A message above the list helper advises you that the selected category users are now stakeholders for the selected assessable records.

Delete a stakeholder for multiple assessable records
You can delete stakeholders for multiple assessable records.

Role required: assessment_admin or admin

1. Navigate to Assessments > Advanced > Assessment Stakeholders.
2. Sort the list by Assessable Record or Category User depending on the perspective you want.
3. Select the check box for each stakeholder you want to delete.
4. Select **Delete** in the **Actions** choice list.
5. Click **OK** to confirm the action.
   The system deletes the stakeholders.

**Associate one category user to one assessable record**
You can create a single stakeholder using the list in the Assessment Stakeholders module.

Role required: assessment_admin or admin

Associate any category user to any assessable record.

1. Navigate to **Assessments > Advanced > Assessment Stakeholders**.
2. Click **New**. On the Assessment Stakeholders form, fill in these fields:
   - **Category user**: Select a category user.
   - **Assessable record**: Select an assessable record.
3. Click **Submit**.
   The selected category user becomes a stakeholder for the selected assessable record. To verify the association, navigate to the assessable record and note that the selected category user is on the Category users related list.

**Note**: Do not create stakeholders from category users and assessable records of different metric types.

**Associate multiple category users to one assessable record**
You can create many stakeholders for a single assessable record from the Assessable Record form.

Role required: assessment_admin or admin

You can also edit or delete stakeholders from the form.

1. Navigate to **Assessments > Assessable Records**.
2. Open a record from the list.
3. In the **Category users** related list, click **Edit**. These category users are the stakeholders for this assessable record.

![Related Links](image)

4. Use the slushbucket to edit the category users associated to this assessable record. Add category users to create stakeholders. Remove category users to delete stakeholders.

The system only shows category users for categories associated to the assessable record. For example, if an assessable record is only associated to the Compliance Score and Support Rating categories, you do not see User Satisfaction category users.

Delete a stakeholder for one assessable record

You can delete stakeholders for one assessable record.
Role required: assessment_admin or admin

1. Navigate to Assessments > Assessable Records.
2. Open an assessable record.
3. In the Category Users related list, select the check box for each stakeholder you want to delete.
4. Select Delete in the Actions choice list.
5. Click OK to confirm the action.
   The system deletes the stakeholders.

Generate an on-demand assessment

Use on-demand assessments to familiarize yourself with the basic assessment process and test your questionnaires using minimal configuration.

Role required: assessment_admin or admin

Select the assessable records to evaluate, create the categories and questions, and then assign an assessment to a user in the system. Pre-configured stakeholders are not used for on-demand assessments.

1. Create a metric type and set the Schedule type to On demand to allow for testing of your assessment configuration.
2. Generate the assessable records for the metric type you created.
3. Create the metric categories required to evaluate the assessable records selected.
4. Create one or more assessment questions, or metrics, for each category.
5. Publish the assessment.
6. Perform an on-demand assessment to test your categories and metrics.
7. Analyze the assessment ratings in an assessment scorecard or decision matrix.

On-demand assessments

On-demand assessments can be generated for metric types with the Schedule type field set to On demand.

For the system to properly generate on-demand assessments, the metric type must be active and published. The metric type must also be associated to at least one metric category. That metric category must be associated to one or more of each of the following items:

- Assessable record
- Metric

By default, an assessment administrator can generate an on-demand assessment for one assessable record or multiple assessable records.

Generate an on-demand assessment for one assessable record

When you generate an on-demand assessment from the Assessable Record form, the resulting assessment contains questions from the categories associated to the assessable record.

Role required: assessment_admin or admin

Publish the assessment.

1. Navigate to Assessments > Assessable Records.
2. Open an assessable record associated to a metric type that has the On demand schedule type.
3. To assign the assessment to users configured in the **Assessors** tab of the assessment, and other specified users, perform these steps.
   a) On the Assessment Metric Type form, click **Assign Assessment**.
   b) Select a user from the Recent Assessors list or select a different user.
   c) Click **OK**.

4. To assign the assessment to users configured in the **Assessors** tab of the assessment, click **Assign to Assessors**.

   The system generates an assessment instance assigned to the selected users.

   **Generate an on-demand assessment for multiple assessable records**

   When you generate an on-demand assessment from the Assessment Metric Type form, the resulting assessment contains questions from all categories associated to any assessable records for the metric type.

   Role required: assessment_admin or admin

   Publish the assessment.

   For example, if there are 15 assessable records associated to at least one category with assessment metrics, the assessment contains questions for all 15 assessable records.

1. Navigate to **Assessments > Metric Definition > Types**.

2. Open a metric type that has the **On demand** schedule type.

3. To assign the assessment to users configured in the **Assessors** tab of the assessment, and other specified users, perform these steps.
   a) On the Assessment Metric Type form, click **Assign Assessment**.
   b) Select a user from the Recent Assessors list or select a different user.
   c) Click **OK**.

4. To assign the assessment to users configured in the **Assessors** tab of the assessment, click **Assign to Assessors**.

   The system generates an assessment instance assigned to the selected users.

   **Generate an assessment with the on-demand API**

   The Assign Assessment buttons call an API to generate on-demand assessments.

   Role required: assessment_admin or admin

1. To generate an assessment, call the **AssessmentCreation API** from any script in the system, such as a business rule or client script.

2. Use the sys_ids of these items:
   • An assessable record to evaluate. The assessable record must be associated with an on-demand type and at least one category that contains non-scripted metrics.
   • One or more users who should perform the assessment. The API generates a questionnaire about the specified assessable record for each user.

**Schedule an assessment**

After you have evaluated your questionnaires using on-demand assessments, edit your categories and metrics as needed, reset your metric type record, and select the users who are qualified to evaluate the assessable records.
Role required: assessment_admin or admin

1. Open the metric type you created for the on-demand assessment and set the Schedule type to Scheduled.
2. Make sure the categories and metrics you created for the on-demand assessment are correct.
3. Create category users who have special knowledge of your categories.
4. Create stakeholders by associating category users to specific assessable records.
5. Set a schedule for automatic assessment generation or generate the assessment manually. This procedure must be done by a system administrator.
6. Configure email notifications to remind users of their assigned assessments and to report to managers when an employee misses an assessment deadline.
7. Analyze the assessment ratings in an assessment scorecard or decision matrix.

Schedule types
You can schedule assessments for preconfigured users or send them to any user on demand.

On-demand assessments require less setup. Scheduled assessments define users, or stakeholders, who have specific knowledge of the records being evaluated, and automatically send out assessment questionnaires to those users at scheduled intervals. The best practice is to configure an on-demand assessment first to familiarize yourself with the process and test your questionnaires. When you are satisfied with your categories and questions, reconfigure for a scheduled assessment. These configuration paths are the easiest for both assessment types. Refer to Key Terms for definitions of the terms used in these procedures.

Set an assessment generation schedule
You can set assessment generation schedules. You must set a schedule for each metric type individually.

Role required: assessment_admin or admin

1. Navigate to Assessments > Metric Definition > Types.
2. Open the appropriate metric type record.
3. Click the reference icon next to the Scheduled job field to open the Schedule Item record.
4. Locate the Trigger type field and set a recurring schedule for the scheduled job.

   For example, if you want to generate assessment components each month, select the Interval or Repeat trigger type and specify a Repeat value of 30 days. Alternatively, select Day in Month and specify a Run time and Run day of month.

   The optimal frequency of assessment generation is subjective. When you set the schedule, keep in mind the number of records to evaluate, how often your organization requires updated assessment results, the time and effort required of users to complete assessments, and other relevant factors.

Publish a metric type
Before it is possible to generate assessments, an assessment administrator must publish the associated metric type.

Role required: assessment_admin or admin

The State field on the Assessment Metric Type form indicates whether the type is published. The default state is Draft, which disables the system from generating assessments.

1. Navigate to Assessments > Metric Definition > Types.
2. Open a metric type record, and click Publish.

   The Publish button is available only if the state is Draft and there is at least one metric associated with the type.

   Note: A metric type cannot be moved back to the Draft state after it has been published.
Scheduled assessments
The system generates a unique scheduled job for each metric type with the Schedule type field set to Scheduled. Each scheduled job generates assessment components for the related metric type. By default, the scheduled job runs when an administrator executes it manually, but administrators can set a schedule to generate assessments automatically on a recurring basis.

For the system to properly generate scheduled assessments, the metric type must be active and published. The metric type must also be associated to at least one metric category. That metric category must be associated to one or more of each of the following items:

- Assessable record
- Stakeholder associated to one of the assessable records
- Metric

Generate a scheduled assessment manually
Administrators can generate scheduled assessments manually.

Role required: assessment_admin or admin

Use this option, for example, if you have set a schedule but want to generate assessments before the next scheduled run date.

1. Navigate to Assessments > Metric Definition > Types.
2. Open the appropriate metric type record.
3. Click Generate Assessments to trigger the scheduled job immediately.

Note: Be careful to click Generate Assessments, not Generate Assessable Records.

Generate a vendor type assessment manually
The Vendor Performance feature provides a direct method of generating assessments for the Vendor metric type.

Role required: admin

1. Navigate to Vendor Performance > Admin > Generate Assessments.
2. Click Generate Assessments to execute the scheduled job for the Vendor type.

Clean up assessment data
The assessment process generates a considerable amount of data, some of which is not useful after a short time.

Role required: assessment_admin or admin

The assessment process generates a considerable amount of data, some of which is not useful after a short time. Assessments include a scheduled job called Remove Old Assessment Data that is available to administrators only. The scheduled job removes these items if they are more than a year old:

- Assessment instance questions
- Assessment instances
- Metric results

By default, the scheduled job is executed manually. Administrators can configure the scheduled job to run automatically on a recurring schedule.

1. Navigate to System Scheduler > Scheduled Jobs > Scheduled Jobs.
2. Open the Remove Old Assessment Data record.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
3. On the Schedule Item form, set the **Trigger type** field to run the scheduled job on a recurring schedule.

   It is recommended to set the scheduled job to run on a weekly or monthly basis.

4. Optional: Click **Execute Now** to run the scheduled job.

**Assessment instances**

An assessment instance represents one occurrence of a questionnaire assigned to one user.

The system generates assessment instances only when the required conditions are met, as described in **Scheduled assessments** and **On-demand assessments**, and there are non-scripted metrics in at least one category.

When the system generates scheduled assessments for a metric type, each assessment instance contains questions about assessable records and categories related to the stakeholder to which it is assigned.

Example:

Recall that there can be multiple stakeholder records associated with one user record. Minh Leclare is a stakeholder for these items related to the **Vendor** metric type:

<table>
<thead>
<tr>
<th>Assessable record</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amazon</td>
<td>User Satisfaction</td>
</tr>
<tr>
<td>Acme</td>
<td>User Satisfaction</td>
</tr>
<tr>
<td>Acme</td>
<td>Reliability</td>
</tr>
<tr>
<td>Cisco</td>
<td>Reliability</td>
</tr>
</tbody>
</table>

When the system generates a scheduled assessment, Minh is assigned one assessment instance. Minh must evaluate Amazon, Acme, and Cisco by answering questions from the categories for which she is a stakeholder. Assuming that there are three questions in the User Satisfaction category and six questions in Reliability, Minh’s questionnaire contains three questions about Amazon, nine questions about Acme, and six questions about Cisco.

When the system generates an on-demand assessment for a specific assessable record, the assessment instance contains questions about that assessable record and all its associated categories. When the system generates an on-demand assessment for a metric type, the assessment instance contains questions about all that metric type’s assessable records and their associated categories.

**View an assessment instance**

An assessment instance represents one occurrence of a questionnaire assigned to one user.
Role required: admin, survey_admin, or assessment_admin

1. Navigate to Assessments > Assessment Instances. The following sub-modules are available based on the state of the instances:
   - **Ready to take**: Displays assessment instances that are ready to be taken by the user. By default, these instances are sorted in ascending order by the Number field.
   - **In progress**: Displays assessment instances that are in progress. By default, these instances are sorted in ascending order by the Number field.
   - **Completed**: Displays assessment instances that are complete. By default, these instances are sorted in descending order by the Taken on field.
   - **Cancelled**: Displays assessment instances that are cancelled. By default, these instances are sorted in ascending order by the Number field.
   - **All**: Displays assessment instances in all states. By default, these instances are sorted in ascending order by the Number field.

2. Click an assessment instance number to open the record from the required sub-module. By default, the following fields are displayed in the Assessment Instance form for all sub-modules other than Completed.

   **Note**: When you open an instance in the Completed sub-module, you are redirected to the User's Response page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Auto-generated record number.</td>
</tr>
<tr>
<td>Metric type</td>
<td>Metric type of this assessment.</td>
</tr>
<tr>
<td>Assessment group</td>
<td>Assessment group to which this assessment belongs.</td>
</tr>
<tr>
<td>Due date</td>
<td>Date by which the assessment instance must be completed.</td>
</tr>
<tr>
<td></td>
<td>The system populates the due date from the value in the metric type</td>
</tr>
<tr>
<td></td>
<td>Assessment duration field.</td>
</tr>
<tr>
<td></td>
<td>The system generates email notifications related to the due date.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: By default, the system runs the Cancel Expired Assessments script</td>
</tr>
<tr>
<td></td>
<td>every 30 days to cancel expired survey, assessment, and quiz instances that</td>
</tr>
<tr>
<td></td>
<td>are in the Work in progress or Ready to take states.</td>
</tr>
<tr>
<td>State</td>
<td>State of the assessment.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain associated with the instance.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User this assessment is assigned to. This field becomes read-only when the</td>
</tr>
<tr>
<td></td>
<td>state is In progress, Complete, or Canceled.</td>
</tr>
<tr>
<td>Signature</td>
<td>Name of the signature record attached to this assessment. A signature</td>
</tr>
<tr>
<td></td>
<td>requires that assessment recipients acknowledge that they have read any</td>
</tr>
<tr>
<td></td>
<td>assertions attached to a questionnaire.</td>
</tr>
</tbody>
</table>
3. Click **Take assessment** to open the questionnaire.

This button is available if all the following conditions are true for the assessment instance:

- It is **Assigned to** you.
- The **State** is **Ready to take** or **In progress**.
- The associated metric type is **Active**.

### Configure trigger conditions for an assessment

Trigger conditions specify when to send a particular assessment and who to send the assessment to.

**Role required:** assessment_admin or admin

1. Navigate to **Assessments > Admin > Trigger Conditions**.
2. Complete the fields as described in the table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment</td>
<td>[Required] Metric type to generate assessment instances for. Triggered assessments only work if the metric type is set to the <strong>On demand</strong> schedule type.</td>
</tr>
<tr>
<td>Table</td>
<td>[Required] Table to run the trigger condition on. You can select only tables in the current application scope.</td>
</tr>
</tbody>
</table>

The table must have a connection to the assessable records for the selected **Assessment**. For example, you might want to send a vendor assessment when incidents close that are related to vendors you assess. In this case, select the Incident [incident] table. After you select a table, ensure there is at least one option for the **Assessable Record Field**. If there is not, select a different table.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User field</strong></td>
<td>[Required] Field that stores the users you want to send the assessment. You can select any field, on the selected <strong>Table</strong> or on a related table, that references the User [sys_user] table. Use the tree picker to select a field.</td>
</tr>
<tr>
<td><strong>Repeat Interval</strong></td>
<td>Minimum period that must pass before the trigger condition can resend the assessment to the same user. For example, assume the repeat interval is set to 30 days. Even if the same user is eligible for multiple assessments from this trigger condition, the system can only send the user one assessment every 30 days.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Check box that determines whether this trigger condition is active (selected).</td>
</tr>
<tr>
<td><strong>Business rule</strong></td>
<td>[Admin only] Business rule the system creates to monitor the selected table. When the condition is met, the business rule sends the assessment to the correct user. No configuration is necessary for this business rule.</td>
</tr>
<tr>
<td><strong>Trigger randomly</strong></td>
<td>Check box that determines whether to send the assessment to the appropriate user every time the condition is met (cleared) or only a percentage of the time (selected), as specified in the <strong>Probability (%)</strong> field.</td>
</tr>
<tr>
<td><strong>Probability (%)</strong></td>
<td>Probability out of 100 that the assessment will be sent each time the condition is met. For example, if the probability is set to 50, the system sends the assessment approximately 50% of the time the conditions are met, assuming there are no repeat interval restrictions. This field is visible and required only when the <strong>Trigger randomly</strong> check box is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assessable Record Field</td>
<td>[Required] Field on the selected Table that determines which assessable record will be the subject of the assessment. Only appropriate reference fields on the selected Table are available to select. If there are no Assessable Record Field options available, you must select a different Table. If the selected Assessment evaluates records on the Company [core_company] table and the selected Table is Incident, the only Assessable Record Field options are fields on the Incident table that reference the Company table. For example, Company or, if vendor ticketing is enabled, Vendor. If you select Vendor, the trigger condition sends an assessment about the Vendor for the incident, assuming there is an assessable record for the associated company. The assessment contains questions from all metric categories associated with the assessable record. <strong>Note:</strong> This field is not available if the selected Assessment is a metric type used for surveys. See Survey trigger conditions.</td>
</tr>
<tr>
<td>Related Field 1 – Related Field 4</td>
<td>Field that contains a value you want to store for reporting purposes. You can pick any reference field on the selected Table. When the trigger condition generates an assessment instance, the system stores the value from the triggering record. Select up to four fields. For example, if you select the Incident table, you might select Caller and Vendor as related fields. That stores the caller and vendor associated with the incident as Related record 1 and Related record 2 in the assessment instance record. To view these fields, configure the Assessment Instance form.</td>
</tr>
<tr>
<td>Description</td>
<td>Summary information to identify the trigger condition.</td>
</tr>
<tr>
<td>Condition</td>
<td>[Required] Condition builder that defines the criteria that must be true to send the assessment. For example, if you want to send an assessment whenever an incident closes, create the condition [State] [is] [Closed].</td>
</tr>
</tbody>
</table>

**Assessment trigger conditions**

A trigger condition tells the system who to send a designated assessment to and when, based on specific conditions.

With trigger conditions, assessment administrators can configure the system to generate assessments each time a specific action occurs, such as when an incident or change request closes. The trigger condition sends the assessment to specified users who are related to the triggering record, such as incident callers or change request assignees. You can choose to send the assessment every time the
condition is met, or set a probability for the system to send the assessment at random when the condition is met.

### Trigger condition configuration

<table>
<thead>
<tr>
<th>Assessment</th>
<th>Vendor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Incident [incident]</td>
</tr>
<tr>
<td>User field</td>
<td>Assigned to</td>
</tr>
<tr>
<td>Repeat Interval</td>
<td>30 days</td>
</tr>
<tr>
<td>Active</td>
<td>true</td>
</tr>
<tr>
<td>Trigger randomly</td>
<td>false</td>
</tr>
<tr>
<td>Assessable Record Field</td>
<td>Vendor</td>
</tr>
<tr>
<td>Related Field 1</td>
<td>Caller</td>
</tr>
<tr>
<td>Related Field 2</td>
<td>Vendor</td>
</tr>
<tr>
<td>Condition</td>
<td>[State] [is] [Closed] and [Vendor] [is not empty]</td>
</tr>
</tbody>
</table>

### Trigger condition example

Modesto Scroggie is the caller on an incident that is assigned to Boris Catino, a service desk technician. Boris contacts a vendor to resolve Modesto's issue and sets the Vendor field to Microsoft. When the incident closes, the system creates an assessment instance assigned to Boris so he can evaluate Microsoft as a vendor.

Because two related fields were selected as part of the trigger condition, the assessment instance stores the following information from the incident:

- **Related record 1**: User: Modesto Scroggie
- **Related record 2**: Company: Microsoft

**Note**: Even though the trigger condition is set to be triggered every time the conditions are met, the Repeat Interval setting ensures that Boris does not receive another assessment if another vendor incident assigned to him closes within 30 days of the first one.

### Enable manager notifications

Users with the assessment_admin role can enable the Notify manager assessment is overdue email notification.

Role required: assessment_admin or admin

This notification sends emails to assessors' managers when assessors do not complete their assigned assessments on time. For more information, see the table of assessment notifications. You must enable or disable this email notification separately for each metric type.

1. Navigate to **Assessments > Metric Definition > Types**.
2. Open a metric type.
3. Select the **Notify if overdue** check box.

![Assessment Metric Type](image)

To disable manager notifications, clear the check box.

4. Save the record.

**Note:** The assessor’s user record must have a manager specified in the **Manager** field to use this notification. You might need to configure the form to use this field.

**Assessment notifications**

You can configure the system to send email notifications for assessments.

You can configure any of the following types of notification during the process of generating assessable records:

- Notify assessment user: This message notifies you of an assigned an assessment and includes the **type**, the due date, and basic instructions. The message also contains a link to the record where you take the assessment.

  **Note:** If a user has a pending assessment, then the system will not generate another instance of the same assessment.

- Remind assessment user: This message reminds you of the due date if half the time passes and you have not completed the assessment. The message content is the same as the first notification.

- Notify manager assessment is overdue: If you do not complete an assessment by the due date, the system may send a notification to your manager, depending on configuration.

  **Note:** By default, the system runs a script every 30 days to cancel expired assessment and survey instances that are in the **Work in progress** or **Ready to take** states.

**Assessment notification workflow**

The system sends assessment notifications according to the Notify assessment user workflow. Users with the workflow_admin, workflow_creator, or workflow_publisher roles can view workflows.

1. To open the graphical Workflow Editor, navigate to **Workflow > Workflow Editor**.
2. In the activity menu, click the link to choose an existing workflow.

Workflow Window
3. Select **Notify assessment user** from the Workflow Versions list. The workflow appears.

![Notify Assessment User Workflow](image)

**View a metric result**

Metric results contain values that represent an evaluated record's performance for a specific metric, based on a single evaluation from one user or from the execution of a script. Metric results contain actual values as well as calculated values. The system uses values from metric results to calculate category results.

Role required: assessment_admin or admin

If there is an active scripted metric when the assessment is generated, the system automatically produces a metric result for each associated assessable record. The system produces an additional metric result for each question a user answers on a completed assessment questionnaire. If multiple users complete questionnaires with the same questions on the same assessable records, the system produces metric results for each user's responses. For example, three users complete questionnaires that contain the same
four questions about the Acme Corporation record. The system produces 12 metric results: one per user for each question.

1. Navigate to **Assessments > Results > Metric Results**.
2. Open the metric result record you want to view.
   All fields on the form except Updated and String value are read-only.

### Metric Result form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment group</td>
<td>Assessment group to which the metric result is associated.</td>
</tr>
<tr>
<td>Metric</td>
<td>Name of the metric to which these metric result values apply.</td>
</tr>
<tr>
<td>Data type</td>
<td>Data type of the metric.</td>
</tr>
<tr>
<td>Method</td>
<td>method of the metric.</td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time the metric result was last updated.</td>
</tr>
<tr>
<td>Source</td>
<td>Source record of the assessable record evaluated.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User who completed the assessment questionnaire. This field is blank when</td>
</tr>
<tr>
<td></td>
<td>the method is Script.</td>
</tr>
<tr>
<td>Instance</td>
<td>Assessment instance completed by the Assigned to user. This field is blank</td>
</tr>
<tr>
<td></td>
<td>when the method is Script.</td>
</tr>
<tr>
<td>Actual value</td>
<td>Unscaled value from a user response or script, depending on the method:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Assessment</strong>: Value obtained from the user response to the assessment</td>
</tr>
<tr>
<td></td>
<td>instance question. The actual value is determined by the metric data type:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Checkbox</strong>: The actual value is 0 if the check box is cleared and 1</td>
</tr>
<tr>
<td></td>
<td>if it is selected.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Choice</strong> or <strong>Likert Scale</strong>: The actual value is equal to the Value</td>
</tr>
<tr>
<td></td>
<td>of the metric definition associated with the chosen answer option.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Date, Date/Time, or String</strong>: The actual value is -1 to indicate</td>
</tr>
<tr>
<td></td>
<td>that these data types do not contribute to category result calculations.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Template</strong>: The actual value is equal to the Value of the template</td>
</tr>
<tr>
<td></td>
<td>definition associated with the chosen answer option.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Yes/No</strong>: The actual value is 0 if the response is No and 1 if it is</td>
</tr>
<tr>
<td></td>
<td>Yes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Script</strong>: Value the script placed in the actual_result variable.</td>
</tr>
<tr>
<td></td>
<td>This field is hidden and left blank when the data type is Duration.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Duration value</td>
<td>Specific kind of actual value that is only applicable if the data type is Duration. The duration value is the value obtained by the script query from the actual_result parameter, such as the average duration of outages for a vendor.</td>
</tr>
</tbody>
</table>
| Scaled value | Appropriate value from the scaled_result variable in the associated metric script. The code in a scripted metric defines a scaling scheme for the actual values it obtains. For example, a scripted metric queries the CMDB to return the number of configuration items (CIs) for a vendor. The code includes this scaling scheme, where actual_result is the number of CIs, and scaled_result is a representation of the quantity of CIs:  
```java
if (actual_result < 1)    
scaled_result = 0;
else if (actual_result < 1000)    
scaled_result = 1;
else if (actual_result < 10000)    
scaled_result = 2;
else if (actual_result < 25000)    
scaled_result = 3;
else if (actual_result < 100000)    
scaled_result = 4;
else    
scaled_result = 5;
```
If the script detects 315 CIs for the vendor, the Actual value is 315 and the Scaled value is 1 for this metric result. |
| Normalized value | Adjusted value that accounts for weights, scale definition, minimum and maximum values, and other factors that impact the metric (like the survey responses or the input value—the actual value given by the user). See the example for Normalized value in View an assessment category result. |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String value</td>
<td>Value that displays the response as it appears on a questionnaire. In some cases this is the same as the <strong>Actual value</strong>, such as when the metric data type is <strong>Percentage</strong>. The string value is <strong>N/A</strong> for unanswered questions of certain data types. For the <strong>Attachment</strong> data type, the names of the attached files are displayed as comma-separated values.</td>
</tr>
</tbody>
</table>

**Assessment results**

In the Assessments application, when the system processes completed questionnaires or gathers values returned from scripted metric queries, it generates assessment result records called metric and category results.

Assessment administrators can view assessment results.

The system calculates **metric results** first, normalizes the scores, and then calculates **category results**. Each metric and category result record stores data from one assessment group, for a particular category and source record evaluated. Specifically:

- Metric results: store data calculated from one evaluation of one metric.
- Category results: store data calculated from a weighted average of all metrics in the category.

**Note:** Although results data is available to view in the form of metric and category result records, the most meaningful way to view results is in scorecards and decision matrixes. These tools display only the most pertinent data in graphical, comparative formats.

**Excluded Responses**

The system creates metric results for responses but does not include them in category result calculations if any of the following are true:

- The user selects the **Not Applicable** answer option on a questionnaire.
- The user does not answer the question and the **data type** is not **Checkbox**.
- The question data type is one of the following: **Date**, **Date/Time**, or **String**.
- The metric result **Actual value**, **Scaled value**, and **Normalized value** fields are set to **-1**.

**Metric Attachments**

After a survey or assessment is submitted, any attachments that have been added by a user are moved to the metric result record. The names of the attached files are added to the **String value** field on the Metric Result form.

**Note:** You cannot add or remove attachments from a metric result.

**Assessments overview module**

The assessment overview module is a type of homepage that displays various assessment reports, such as results by category and assessments by state.
Prerequisites

You can view the overview page and refresh, add, delete, and rearrange report widgets.

Role required: assessment_admin
To use the Assessments Overview module, navigate to Assessments > Overview and click elements within the reports to obtain more information.

The available reports are:

Assessments overview module reports descriptions

<table>
<thead>
<tr>
<th>Report</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessable Records by Type</td>
<td>Assessable Record</td>
</tr>
<tr>
<td>Assessment Instances by Assessment Group</td>
<td>Assessment Instance</td>
</tr>
<tr>
<td>Assessments by State</td>
<td>Assessment Instance</td>
</tr>
<tr>
<td>Answered Questions by Assigned User</td>
<td>Assessment Instance Question</td>
</tr>
<tr>
<td>Average Rating by Type</td>
<td>Assessment Category Result</td>
</tr>
<tr>
<td>Category Result Ratings by Category</td>
<td>Assessment Category Result</td>
</tr>
<tr>
<td>Metrics by Data Type</td>
<td>Assessment Metric</td>
</tr>
<tr>
<td>Stakeholders per Category</td>
<td>Assessment Stakeholders</td>
</tr>
<tr>
<td>Top Rated Items</td>
<td>Metric Result</td>
</tr>
<tr>
<td>Total Metrics by Metric Type</td>
<td>Assessment Metric</td>
</tr>
<tr>
<td>Unanswered Questions by Assigned User</td>
<td>Assessment Instance Question</td>
</tr>
</tbody>
</table>

Assessment results calculation

For every assessment group, there are assessment results.

Data calculated from an evaluation of one metric is classified as a metric result. Data calculated from the weighted average of all metric results in a category is classified as a category result. The system calculates some assessment results when the assessment is generated, and others when users complete questionnaires.

View a bubble chart for assessments

Assessment administrators can view bubble charts to compare the relative standing of assessable records in three metric categories.

Role required: assessment_admin or admin

1. Navigate to Assessments > Admin > Bubble Charts.
2. Click a Name to open the bubble chart record.
3. Under Related Links, click View Bubble Chart.

Note: Demand managers and vendor managers can view bubble charts through the Demand Management and Vendor Performance applications. See Project Portfolio Suite for more information.

Bubble charts for assessments

A bubble chart is a dynamically updated graph that plots assessment results for multiple assessable records.

Assessment administrators can create and use bubble charts to compare the relative standing of assessable records in three metric categories. The X- and Y-axes each represent a different category. Assessable records are plotted on the chart as circular markers, or bubbles, which vary in size according to scores for the third category.
Create a bubble chart

Assessment administrators can create bubble charts to compare the relative standing of assessable records in three metric categories.

To create a bubble chart, navigate to **Assessments > Admin > Bubble Charts** and create a record (see table for field descriptions).

**Note:** For color fields, either HTML color names or hexadecimal (hex) values are acceptable. For hex values, the # character is optional. Values are not case-sensitive. For example, all of the following values are valid: LightGray, lightgray, #D3D3D3, d3d3d3.

![Bubble Chart form](image)
**Bubble Chart form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for the bubble chart. <strong>Bubble Chart</strong> is appended to the name when you view the bubble chart.</td>
</tr>
<tr>
<td>• Top left label</td>
<td>Label text for the top left, top right, bottom left, and bottom right quadrants, respectively. Choose labels that help interpret results. For example, a bubble chart that displays vendor assessment results might have the following quadrant labels, where vendors in the top right quadrant have the best scores:</td>
</tr>
<tr>
<td>• Top right label</td>
<td></td>
</tr>
<tr>
<td>• Bottom left label</td>
<td></td>
</tr>
<tr>
<td>• Bottom right label</td>
<td></td>
</tr>
<tr>
<td>• Top left color</td>
<td>Border colors for the top left, top right, bottom left, and bottom right quadrants, respectively. Bubbles are the color of the quadrant they are in.</td>
</tr>
<tr>
<td>• Top right color</td>
<td></td>
</tr>
<tr>
<td>• Bottom left color</td>
<td></td>
</tr>
<tr>
<td>• Bottom right color</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Metric type associated with this bubble chart. Only results for assessable records of the selected metric type are plotted on the bubble chart.</td>
</tr>
<tr>
<td>• X-Axis label</td>
<td>Label text for the X-, Y-, and Z-axis categories of the bubble chart. These labels appear along the X- and Y-axes, if applicable, and in bubble score summary windows. The metric category name is usually a good label. If these fields are left empty, the bubble chart automatically displays the selected category names as the labels.</td>
</tr>
<tr>
<td>• Y-Axis label</td>
<td></td>
</tr>
<tr>
<td>• Z-Axis label</td>
<td></td>
</tr>
<tr>
<td>• Metric X category</td>
<td>Metric category each axis represents. Results for the Z-axis category determine the size of each bubble. The Z-axis should generally represent the most important category out of the three.</td>
</tr>
<tr>
<td>• Metric Y category</td>
<td></td>
</tr>
<tr>
<td>• Metric Z category</td>
<td></td>
</tr>
<tr>
<td>Quadrant label color</td>
<td>Color of the label text for the quadrant borders.</td>
</tr>
<tr>
<td>Default</td>
<td>Check box that enables (selected) or disables (cleared) the bubble chart as the default. There can be only one default bubble chart per metric type.</td>
</tr>
</tbody>
</table>

**Bubble chart components**

The X- and Y-axes each represent a different metric category. Assessable records are plotted on the chart as circular markers, or bubbles, which vary in size according to scores for the third category.

The bubble chart page has these components:

- **Bubble Chart**
  - **X- and Y-axes**: Each axis represents a metric category.
  - **Bubbles**: Each labeled bubble represents an average of category result data for an assessable record. Point to a bubble to view an assessable record score summary. Click a bubble or bubble label to view the scorecard for the assessable record.
• **Source record list:** List of all records defined by the **Table** and **Condition** fields for the associated **metric type**. Note that the bubble chart only plots records for which there are assessment results. The assessment results are actually associated with the assessable records for each of the listed source records.
Vendor Quality Bubble Chart

<table>
<thead>
<tr>
<th>Companies</th>
<th>Source record list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acor</td>
<td></td>
</tr>
<tr>
<td>Adobe Systems</td>
<td></td>
</tr>
<tr>
<td>Adtran</td>
<td></td>
</tr>
<tr>
<td>Apple</td>
<td></td>
</tr>
<tr>
<td>Amazon</td>
<td></td>
</tr>
<tr>
<td>America Online</td>
<td></td>
</tr>
<tr>
<td>Apache Software Foundation</td>
<td></td>
</tr>
<tr>
<td>APC</td>
<td></td>
</tr>
<tr>
<td>Apple</td>
<td></td>
</tr>
<tr>
<td>Asus</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Assessable record score summaries

Point to a bubble to display a score summary for the assessable record the bubble represents.

The summary displays the assessable record's average score for each category in the following order: X-axis category, Y-axis category, Z-axis category. The scores are based on data from the last 12 months.

![Bubble chart score summary](image)

View an assessment scorecard

The Assessments application prepares printable scorecards. A scorecard displays easy-to-interpret assessment results, in which the current calculated ratings for an assessable record are compared to previous ratings or to the ratings of other records.

Role required: assessment_admin or admin

Users can examine ratings over time, compare ratings for one assessable record with all assessable records in a table, or compare the ratings of two assessable records. All ratings are averages for the time range selected. The system dynamically updates a scorecard each time you view it, so the ratings reflect recently completed assessments and scripted metrics.

Administrators can display a scorecard for any table by creating a Related Link on assessable records. The system provides this link on the Company form by default when Vendor Performance is active.

The Vendor Performance application provides an enhanced scorecard view for vendors.

See Vendor Performance in . Project Portfolio Suite.

1. Navigate to Assessments > Assessable Records.
2. Open a record.

Create a link to a scorecard

Users with the admin role can create UI actions that allow users to view scorecards from tables.

Role required: assessment_admin or admin

1. Generate assessable records you want to evaluate.

   For example, you might create a metric type called Project to assess project management records.
2. Navigate to **System Definition > UI Actions**.
3. Open the View Scorecard record.
4. Right-click the header bar and select **Insert and Stay** from the context menu to create a duplicate record.
5. Change the **Table** name to the table on which you want the UI action to appear.
   For example, you might select Project [pm_project].

![UI Action](image)

6. Do not edit the **Action name** field or the **Condition** script.
7. Save the record.
8. Navigate to the table on which you created the UI action and open an assessable record.
   a) In this example, navigate to **Project > Projects > All**.
   b) Open any record in the list.
   c) Click **View Scorecard** under **Related Links** to open the scorecard for that assessable record.

The scorecard appears with the title in the form of `<table display name> Scorecard`. For example, a scorecard for an assessable record in the Project [pm_project] table is named **Project Scorecard**.

**Note:** Content does not appear in the scorecard unless the associated assessable record has assessment results or related live feed conversations.
9. Insert a new **View Scorecard** UI action record for each table where you want the related link to appear.

**Export a quiz scorecard as an image**

You can export scorecards as images.

Role required: assessment_admin or admin

1. Click the menu icon and select **Save as PNG** or **Save as JPEG** as the download format.
2. When the export is complete, select **Download** to save the scorecard image to a storage location.

---

**Assessment scorecard averages**

The Averages view compares the current ratings for an assessable record in each metric category with the average, minimum, and maximum values from all assessable records in the filter. All ratings are from assessments generated over the trailing twelve months (TTM).

Select a filter option to compare the current record against all assessable records in that filter. An assessment administrator configures these options in the **Filter field** field in the Assessment Metric Type form.

Rating variances are highlighted as follows:

- **Red**: Ratings are below average in this category. The **Diff** value displays a negative number.
- **Green**: Ratings are above average in this category. The **Diff** value displays a positive number.
- **White**: Ratings are average in this category. The **Diff** value is 0.0.

In the following example, the ratings of the current group are compared against other groups for which Don Goodliffe is the manager.

**Group scorecard with ratings filter**

**Assessment scorecard categories**
The Categories view displays a bar chart showing the average ratings for each category in the selected time interval.

Select from these reporting periods:
- All History
- Last 3 Months
- Last 12 Months
Scorecard categories

*Assessment scorecard category metrics*

The Category Metrics view displays the weighted average results for each metric within a category. Use this view to learn how individual metrics affect the overall rating for the category.

Select a metric category from the choice list to display the chart.
Scorecard category metrics

Assessment scorecard head-to-head compare view
The Head to Head Compare view allows you to compare the ratings of two assessable records of the same type. Select an assessable record from the choice list to compare against the current record's trailing twelve month (TTM) ratings.

Head to head compare
The Diff column displays the difference between each assessable record's most recent TTM ratings. By default, the system selects the first assessable record in the list when you open this view. The scorecard displays three years of ratings for the comparison record. All ratings are expressed as averages.
Scorecard head to head compare

**Overall Rating**

The Overall Rating is calculated as:

\[
\frac{\text{sum of normalized values in category result}}{\text{number of assessment groups}}
\]

In the following example, the calculation is

\[
\frac{(2.13 + 2.86 + 3.79 + 1.43 + 2.39 + 3.7)}{2} = 8.15
\]
## Normalized values

<table>
<thead>
<tr>
<th>Assessment group</th>
<th>Category</th>
<th>Weight</th>
<th>Source</th>
<th>Rating</th>
<th>Normalized value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG0000804</td>
<td>Politeness</td>
<td>5</td>
<td>Group: NY DB</td>
<td>6.29</td>
<td>1.43</td>
</tr>
<tr>
<td>ASG0000804</td>
<td>Recommendation</td>
<td>7</td>
<td>Group: NY DB</td>
<td>7.5</td>
<td>2.39</td>
</tr>
<tr>
<td>ASG0000804</td>
<td>Responsiveness</td>
<td>10</td>
<td>Group: NY DB</td>
<td>8.14</td>
<td>3.7</td>
</tr>
</tbody>
</table>

### Overall Rating on the group scorecard

<table>
<thead>
<tr>
<th>Category</th>
<th>Current</th>
<th>Diff</th>
<th>2017</th>
<th>2016</th>
<th>2015</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Rating</td>
<td>4.96</td>
<td>0.15</td>
<td>4.81</td>
<td>4.18</td>
<td>3.54</td>
</tr>
<tr>
<td>Importance Rating</td>
<td>3.30</td>
<td>0.44</td>
<td>2.86</td>
<td>2.40</td>
<td>1.26</td>
</tr>
<tr>
<td>Compliance Score</td>
<td>4.81</td>
<td>0.33</td>
<td>4.48</td>
<td>3.25</td>
<td>2.75</td>
</tr>
<tr>
<td>User Satisfaction</td>
<td>5.29</td>
<td>0.35</td>
<td>4.94</td>
<td>4.29</td>
<td>3.33</td>
</tr>
</tbody>
</table>
**Assessment scorecard history**

The History view compares the current ratings for each category with ratings from the previous three years or four quarters.

Ratings that have declined are highlighted in red and display negative numbers. Ratings that have improved are highlighted in green with positive numbers. Arrow icons beside the values in the **Diff** column indicate the trend of the current assessment against the previous assessment.

- **3 Years**: To calculate the current ratings, the system averages the ratings from the trailing twelve month (TTM) period. The **Diff** column shows the discrepancy between the current ratings and the previous calendar year's ratings.

![Group Scorecard](image)

**Scorecard history - 3 years**

- **4 Quarters**: Quarterly assessments compare the average rating for each category in the current quarter against the average ratings from the previous four quarters. The **Diff** column shows the discrepancy between the current ratings and the previous quarter's ratings. The column labels count backward, by quarter from the current quarter. For example, if the current quarter is the 3rd quarter of 2013, then the
previous quarters appear as 2nd [2013], 1st [2013], 4th [2012], and 3rd [2012]. All four of the previous quarters appear, whether or not there was any data for those quarters.

Scorecard history - 4 quarters

Live feed view of assessable records
The live feed view displays live feed conversations that apply to the assessable record. Users can view the group feed, including tagged comments, and add comments of their own.

To configure a live feed view, an assessment administrator selects the Live feed check box on the Assessable Record form. Live feed is available on the scorecard even if there are no category results for the other views.

The live feed view provides these viewing options:

- **My Feed**: Displays the user's My Feed preferences.
- **Company**: Displays the user's company feed.
- **Groups**: Displays all available groups and gives the logged in user the option to leave or join a group. Select a group to display that group's conversations.
- **Tags**: Displays all the tags found in live feed comments. Click a tag to display the conversations containing that tag.
Live Feed group scorecard
**Assessment scorecard ratings**
The scorecard ratings section displays various ratings for the assessable record.

Select one of several views that present different ratings:

- Averages
- Categories
- Category Metrics
- Head to Head Compare
- History
- Live Feed

Some views display an overall rating column, which lists categories used to evaluate the assessable record. Only categories in which the assessable record has been evaluated appear on the scorecard. If the ratings section does not display any data, the assessable record or category results associated to the assessable record have been deleted.

Click a category to view the category record. Point to a category to display a line chart that shows the rating trend for that category.

---

**Vendor scorecard trend chart**

---

**Set up and administer quizzes**

Set up and administer quizzes.

Role required: assessment_admin or admin

1. Optional: Create reusable question templates for quizzes.
2. Create the quiz using the Quiz Designer or with forms accessed from the navigation menu.
   
   The quiz record includes specifics such as duration, notification preferences, a questionnaire introduction, and ending notes displayed to recipients.
3. Edit the default category or create additional categories as needed.
   
   The system creates a category with the same name as the quiz.
4. Define users for each category.
   
   These are the recipients who answer the questions in a category. You can define different users for each category.
5. Create the questions for each category.
6. Create the answers for each question and determine if the questions are scored.

You can create unique answers or select preconfigured answers from a template.

Publish and distribute the quiz. You can send the quiz to a single user or all users in each category.

Review the results from the submitted quizzes in reports and scorecards.

**Quizzes**

Quizzes are questionnaires you can assign to one or more users to assess their knowledge of any subject. The quiz functionality is built on the assessment engine and provides many of the same features as assessments and surveys.

Each question is scored, and the overall score indicates the percentage of questions the user answered correctly. A quiz may have categories of questions that are assigned only to some users. You can assign weighting values to individual questions or categories of questions that make them more or less important when calculating the overall score. Quizzes require activation by a system administrator.

- An administrator can create a quiz for any purpose and assign it to a single user or multiple users.
- A quiz can contain one or more categories of questions. Each category can be assigned to users who answer only the questions in that category.
- The system can send email notifications to these users:
  - **Recipients**: The recipient can receive notification of an assigned quiz, a quiz whose allowed duration is at 50%, and a quiz that is overdue.
  - **Recipient's manager**: The recipient's manager can receive notification when a quiz is overdue.
  - **Quiz manager**: The quiz manager can receive notification of an overdue quiz to which he or she is assigned.

- Quizzes can contain questions that are scored or not scored. Unscored questions assess opinions or involve dates and are not counted in the final score. Scored questions specify correct answers and are scored either as 0% or 100%. You can apply a weighting scale to scored questions to establish their relative importance. You can designate questions with these data types as scored questions:
  - Checkbox
  - Choice
  - Duration
  - Likert Scale
  - Numeric Scale
  - Template
  - Yes/No

- A quiz question can be dependent on the response to any scored question. For example, you can create a dependent question requesting additional information that appears only if a recipient answers **No** to a specific question.

**Important terms**

The quiz application involves several terms.
Terms used in quiz application

<table>
<thead>
<tr>
<th>Terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quizzes</strong></td>
<td>A quiz contains information such as duration, state, and notification controls and lists the existing categories. Text fields on the quiz form allow an administrator to create introductory content and end notes that are displayed to the recipient.</td>
</tr>
<tr>
<td><strong>Categories</strong></td>
<td>A quiz category represents a theme for quiz questions. Each category contains one or more questions and names the recipients for the questions in that category. By default, the system creates one category with the same name as the quiz. You can create additional categories as needed. Categories can be weighted higher or lower to determine the importance of that category in the overall score.</td>
</tr>
<tr>
<td><strong>Questions</strong></td>
<td>A quiz question is a question configured for a category and sent only to the users for that category. Questions have a wide variety of data types and can be individually weighted higher or lower. Questions may be scored or unscored.</td>
</tr>
<tr>
<td><strong>Category user</strong></td>
<td>A category user is the recipient of questions for a specific category. You can select different users to answer the questions for each category.</td>
</tr>
<tr>
<td><strong>Templates</strong></td>
<td>A template is a question data type that provides reusable rating scales for answers to questions. For example, the answer template named Satisfaction contains a satisfaction scale ranging from Very Satisfied to Very Dissatisfied.</td>
</tr>
</tbody>
</table>

**Quiz roles**

The Quizzes application uses these roles. No role is required to take quizzes that are assigned to you.

<table>
<thead>
<tr>
<th>Role Title [Name]</th>
<th>Role Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>assessment administrator [assessment_admin]</td>
<td>Can administer the Assessments application and all quiz records. Can access all the modules of the Assessments application. <strong>Note:</strong> The itil_admin role and the survey_admin role contain the assessment_admin role</td>
</tr>
<tr>
<td>Administrator [admin]</td>
<td>Can access all aspects of the assessment and survey processes. Only administrators can modify survey notifications, create survey modules, and import surveys.</td>
</tr>
</tbody>
</table>
Data types for quizzes
You need to choose a data type for each quiz question. Various data types helps you collect and analyze different kinds of data.

Available data types

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Question with a Manage Attachments icon that allows users to attach one or more files.</td>
</tr>
<tr>
<td>Boolean</td>
<td>Question with a check box or a Yes/No list for user responses.</td>
</tr>
<tr>
<td>Choice</td>
<td>List of predefined options. For more information, see the definition for Choices in the Create quiz questions topic. Multiple correct answers are supported.</td>
</tr>
<tr>
<td>Date</td>
<td>Date field.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Time and date field.</td>
</tr>
<tr>
<td>Number</td>
<td>Number field with predefined minimum and maximum values. The default is 1-10.</td>
</tr>
<tr>
<td>Percentage</td>
<td>Percentage field with a prescribed range.</td>
</tr>
<tr>
<td>Scale</td>
<td>Predefined Likert scale. Answer options appear as radio buttons. Multiple correct answers are supported.</td>
</tr>
<tr>
<td>Image Scale</td>
<td>Predefined set of images. Five emojis similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Multiple correct answers are supported.</td>
</tr>
<tr>
<td>Numeric scale</td>
<td>Selectable number scale. The default is 1-5. Answer options appear as radio buttons. Multiple correct answers are supported.</td>
</tr>
<tr>
<td>String</td>
<td>Single or multi-line text field.</td>
</tr>
<tr>
<td>Template</td>
<td>Choice list of templates that provide a predefined scale of options. For details, see Configure a template question. Multiple correct answers are supported.</td>
</tr>
<tr>
<td>Reference</td>
<td>Choice list of fields from a specified reference table. This data type does not support reference qualifiers.</td>
</tr>
</tbody>
</table>

Activate the quiz designer
Administrators can activate the Quiz Designer plugin.

Role required: assessment_admin or admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.*

---

**Quiz Overview module**

The Quiz Overview module is a homepage that displays various reports on data such as results for each category and quizzes that are complete, pending, or in progress.

Role required: assessment_admin or admin

Users with the assessment_admin role can view the overview page and refresh, add, delete, and rearrange widgets.

1. Navigate to **Quizzes > Overview**.
2. Click elements within reports to obtain more information. The available reports are:

<table>
<thead>
<tr>
<th>Report</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes by State</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
</tr>
<tr>
<td>Total Questions by Quiz</td>
<td>Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Questions by Data Type</td>
<td>Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Correct Answers by Assigned User</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Number of Correct Answers</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Incorrect Answers by Assigned User</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Number of Incorrect Answers</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
</tbody>
</table>

**Quiz designer**

The quiz designer provides a single interface that users with the assessment_admin role can use to create, edit, and distribute quizzes.

You can also use it to edit existing quizzes and change scoring parameters.

Alternatively, you can use the modules of the assessment engine to create and edit the records that make up a quiz. All quiz records are stored in assessment tables and displayed in Quiz views of those tables. For details, see Create quizzes with forms.

**Tools on the Quiz Designer**

The quiz designer includes a design canvas, a header bar, and many controls that you can use to create quizzes.

To open the quiz designer, navigate to **Quizzes > Quiz Designer**.

The designer contains the following elements:

- Controls tab
- Questions tab
- Categories tab
- Header bar
- Design canvas
Controls tab

Controls for the supported question data types are available in the Controls palette. Drag and drop a control onto the designer canvas to create a question of that type.

Question controls
## Question controls

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
<th>Scored</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Question with a Manage Attachments icon that allows users to attach one or more files.</td>
<td>Y</td>
</tr>
<tr>
<td>Boolean</td>
<td>Question with a check box or a Yes/No list for user responses.</td>
<td></td>
</tr>
<tr>
<td>Choice</td>
<td>List of predefined options. For more information, see the definition for Choices Create quiz questions. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Date</td>
<td>Date field.</td>
<td>N</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date and time field.</td>
<td>N</td>
</tr>
<tr>
<td>Number</td>
<td>Number field with predefined minimum and maximum values. The default is 1-10.</td>
<td>N</td>
</tr>
<tr>
<td>Percentage</td>
<td>Percentage field with a prescribed range.</td>
<td>N</td>
</tr>
<tr>
<td>Scale</td>
<td>Predefined Likert scale. Answer options appear as radio buttons. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Numeric Scale</td>
<td>Selectable number scale. The default is 1-5. Answer options appear as radio buttons. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Image Scale</td>
<td>Predefined set of images. Five emojis similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>String</td>
<td>Single or multiline text field.</td>
<td>N</td>
</tr>
<tr>
<td>Template</td>
<td>Choice list of templates that provide a predefined scale of options. For details, see Configure a template question. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Reference</td>
<td>Choice list of fields from a specified reference table. This data type does not support reference qualifiers.</td>
<td></td>
</tr>
</tbody>
</table>
Questions tab

This tab displays all metrics added to the question bank for quizzes. Use the Filter field to search for questions. Each metric is displayed with its name and type.

Categories tab

This tab displays all metric categories added to the question bank for quizzes. All metrics in the question bank are group under the corresponding metric category. Use the Filter field to search for categories or questions.

Header Bar

The header bar contains tabs that display different views and a menu of various functions.

Click one of the following tabs to change the view in the canvas:

• **Design**: Add categories and questions, and configure the properties of each. This is the default view of the canvas when you open the designer.
• **Configuration**: Create introductions and end notes for quizzes, and select a signature.
• **Availability**: Select the recipients for each category in the quiz.

Point to the menu icon (≡) in the in the upper right of the quiz designer to select the following options:

• **Save**: Saves the current quiz.
• **Preview**: Displays a preview of the quiz as it appears to the recipients.
• **Publish**: Distributes the quiz to the selected recipients.
• **Save and Publish**: Saves and distributes the quiz in one step.
• **New Quiz**: Opens a fresh canvas for a new quiz.
• **Load Quiz**: Opens a list of existing quizzes that you can select and edit.
• **Copy Quiz**: Creates a copy of the quiz.

The availability of each option depends on the status of the quiz that is opened in the quiz designer.

Design Canvas

New quizzes open in the Design view. The quiz Name field appears above first category in the canvas. A blank question field appears in the category container.

Create a quiz

When you create a quiz, you can create one or more categories and then add questions to each category.

Role required: assessment_admin or admin

Each category can be assigned to a different user or the same users. You can also customize each question and make it dependent on the response to another question.

Create a quiz using these procedures:

Create quiz categories

A category represents a theme for evaluating a specific element of the quiz topic and contains questions pertaining to that theme.

Role required: assessment_admin or admin
When you create a quiz, the system creates a default category, using the name of the quiz. You can use this category, modify it, or create additional categories as needed. To have any results, a category must contain scored questions.

1. Navigate either Quizzes > Quiz Designer or Quizzes > Quizzes and click Quiz Designer in the list header.
2. Enter the name of the quiz in the Name field. The system uses this name as the name of the quiz and the first category
3. To configure the category, click the gear icon in its title bar.
   The Properties dialog box appears. You can change the name of the category, add a description for it, and enter text in the Details field that introduces or explains the category to the recipients. The system updates the category as you type.
4. Click the X icon to close the category properties dialog box and save your settings.

5. To add a new category, click the + icon in the title bar of an existing category.

Create quiz questions
You can create multiple questions for each category but each question can be associated with only one category.

Role required: assessment_admin or admin
The data type that you select for each question determines how it can be answered by quiz recipients.
You can designate questions to be scored. Only scored questions are shown in the quiz results and considered when calculating the category results. You must also specify a correct answer for scored questions.
1. In the Design view, drag a data type icon from the Controls palette and drop it into a category container.

Note:
To designate a question as scored, you must use Assessment forms. For instructions, see Configure a scored question.
2. To configure the question, click in the gear icon in its title bar. The Properties dialog box appears for the question.

3. Fill in the fields on the form, as appropriate.

**Question property fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Required] Name of the question. Create a concise and easily recognizable name for your question. The system uses this value to identify the question in Assessment Metric lists and in scorecard charts.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to display as the question on quizzes. Enter a clear, straightforward question that is easy to understand.</td>
</tr>
<tr>
<td>Type</td>
<td>[Read-only] Data type selected for this question. See the table in Controls for possible data types.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this question is available on a quiz. If a question is marked inactive, it does not appear on quizzes generated after the question becomes inactive.</td>
</tr>
<tr>
<td>Boolean option</td>
<td>Whether a check box or a Yes/No list appears as the option for the Boolean question.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box for requiring users to answer the question. Users cannot submit quizzes until they answer all mandatory questions, which are denoted by a red field status indicator. This field is available when the question does not have a dependency and the question Controls is not Boolean with a check box option.</td>
</tr>
</tbody>
</table>
| String option      | Setting for the appearance of a string field in a question. This field is available when the question type is String. The string options are:  
  - Single line: Single line text field 40 characters in length that allows strings of any length.  
  - String line wide: Full page width text field that allows a single line entry of any length.  
  - Multiline: Full page width multi-line text field that allows word wrap and returns.                                                                                          |
| Min                | Lowest positive whole number that users can enter or select to answer the question. This field is available when the question type is Number, Percentage, or Numeric Scale.                                                                                                                                                                                                                                                                  |
| Max                | Highest positive whole number that users can enter or select to answer the question. This field is available when the question type is Number, Percentage, or Numeric Scale.                                                                                                                                                                                                                                                                  |
| Allow not applicable | Check box for including Not Applicable as an option for this question. Users can select Not Applicable if they do not have sufficient information to respond to a question. User responses of Not Applicable are excluded from results calculations. This field is available when the question does not have a dependency and the question data type is not Boolean with a check box option. |
| Randomize answers  | Check box for displaying answer options in a random order whenever the question appears in a quiz. Answer preference is sometimes influenced by the order in which options appear, which can result in biased results. Randomizing options can help prevent this bias. Note: Randomizing options for certain questions may make those questions confusing for users. In general, only randomize options that do not follow a logical order. |

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Information about the question that is displayed on the quiz. Include details that help users understand how to answer the question. You can also enter HTML text in this field with the WYSIWYG editor. For example, include HTML to embed links and images.</td>
</tr>
<tr>
<td>Correct answer</td>
<td>Answer option that you want to be selected by users. When you specify a correct answer for a question, the system scores the question. This field is available for all data types except <strong>Date</strong>, <strong>Date/Time</strong>, and <strong>String</strong>. Multiple correct answers are supported for a few data types. See data types.</td>
</tr>
<tr>
<td>Choices</td>
<td>Options for a question with a data type of <strong>Choice</strong> or <strong>Scale</strong>. The system automatically adds text and values that you can edit for each option. Click the + icon to add an option, or click the X icon to delete an option. By default, the system arranges options in the order established by their values. To change the order, drag and drop the options.</td>
</tr>
<tr>
<td>Dependency</td>
<td>Condition builder that hides or displays the question depending on the answer to another question in the same category. Select an existing question from the list with a data type of <strong>Boolean</strong>, <strong>Choice</strong>, <strong>Scale</strong>, or <strong>Template</strong>. Create the condition that must exist for recipients to see the dependent question, using the <strong>is</strong> or <strong>is one of</strong> operator. The system prevents recursive dependencies between questions. For example, if Question A depends on Question B, Question B cannot depend on Question A.</td>
</tr>
</tbody>
</table>

4. To create any special conditions that must be met for a question to appear on the quiz, click the **Dependency** tab. Fill in the fields, as appropriate.

   Dependent questions appear on the quiz when a recipient selects a specific answer or combination of answers to another question in the same category

5. Select a question in the **Displayed when** field. The system selects the appropriate operator and displays the possible answers for the selected question.
6. Select the answers that satisfy the condition. Selected answers are indicated by a check mark.

7. Click X to close the question properties dialog box and save your settings.
8. To add a question with the same data type as an existing question in the category, click the + in the title bar of the existing question.
9. Drag questions to change their order within a category or move them between categories.
10. To delete a question, click the X in its title bar.

Configure a quiz
You can configure an entire quiz.

Role required: assessment_admin, survey_creator, or admin

The values you enter and select on this page are applied to the entire quiz.

In the quiz designer, click **Configuration** and then fill in the fields as described in the table.

**Quiz designer configuration**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box for enabling the distribution of this quiz to recipients.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of this configuration or the quiz to which it is attached.</td>
</tr>
<tr>
<td>Introduction</td>
<td>Introductory content to display on quizzes. You can add a welcome message or background information about the quiz.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Owners</td>
<td>Owners of the quiz. You can add a user with the survey_creator, survey_admin, or assessment_admin role.</td>
</tr>
<tr>
<td>Signature</td>
<td>[Optional] Acknowledgement by a quiz recipient of requirements, admonitions, or expectations related to a quiz.</td>
</tr>
<tr>
<td>Return URL</td>
<td>Destination address of a web page that is presented to users after they submit a completed quiz. When a return URL is configured, the End note content does not appear.</td>
</tr>
<tr>
<td>End note</td>
<td>Content that is displayed to recipients after they submit a completed quiz. You can add a thank you message, follow-up instructions, or other applicable information. End notes are not displayed if a Return URL is specified.</td>
</tr>
<tr>
<td>Duration</td>
<td>Amount of time that recipients are given to complete this quiz, starting from the time that the quiz is generated. The default duration is 14 days.</td>
</tr>
<tr>
<td>Manager</td>
<td>Assessment manager for this quiz. These users are only responsible for managing the quiz process and not the results. The system notifies the manager when submissions for this quiz are past due.</td>
</tr>
<tr>
<td>Notify manager if overdue</td>
<td>Check box for sending email notifications to a recipient’s manager when that user fails to submit an assigned quiz before the due date.</td>
</tr>
</tbody>
</table>

### Related Links

**Show Benchmarks**

Opens the Benchmarks Dashboard that provides visibility into your key performance indicators (KPIs) and trends.

**Note:**

- This related link is available only for survey_admin, assessment_admin and survey_reader with bm_viewer role.
- You must opt in to Benchmarks to view the dashboard. See Enable Benchmarks
- This is applicable only for a published quiz.

---

Select a quiz recipient

When the system distributes a quiz, it sends email notifications to the category users and their managers.

**Role required:** assessment_admin or admin

A category can have one or more assigned users, and the same user can be assigned to more than one category.
The system also creates a link to the quiz in the recipients’ My Assessments & Surveys portal. Users can only answer questions in the categories that they are assigned to.

To select the recipients for each quiz category, click Availability and then fill in the fields as described in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select category</td>
<td>Category for which the selected users are recipients.</td>
</tr>
<tr>
<td>Add users</td>
<td>Users selected as recipients for this category. The choice list shows all users in the system.</td>
</tr>
</tbody>
</table>

Publish a quiz
When you publish a quiz, the system sends email notifications to the recipients and to their managers. A card in each recipient’s My Assessments & Surveys portal displays a link to the quiz.

Role required: assessment_admin or admin

1. If you want to see the quiz as the recipients will see it, point to the menu icon in the upper right of the quiz designer and click Preview.
2. When you are satisfied with the quiz, click Save and Publish or Publish to distribute it.

Create quizzes with forms
As an alternative to the Quiz Designer, you can create a complete quiz using records in the Assessment application.

All the elements of a quiz, the categories, questions, and answers, are stored in tables used by the assessment engine and are displayed in quiz views of these tables. Users creating quizzes in the Assessment application must have the assessment_admin role.

Create a quiz using assessment forms by following the procedures in the order shown here:
• Create the quiz.
• Set up the categories.
• Create the questions for the quiz.
• Create the answers for the questions.
• Distribute the quizzes to recipients.

Note: The recommended method of creating and editing quizzes is to use the quiz designer, which provides a single, intuitive interface for creating and editing quizzes quickly. If you determine that you need to add specific features to your quiz not offered through the quiz designer, you can do so by using some of the specific procedures described here.

Set up a category
A category represents a theme for evaluating a specific element of the quiz topic and contains questions pertaining to that theme.

When you create a quiz, the system creates a default category with the name of the quiz. You can use this category, modify it, or create additional categories as needed. Categories are records in the Quiz view of the Metric Category table.
Categories have weighting values that contribute to the overall score for the quiz. By default, all categories are given a weighting value of 10. You can assign any weight to your categories. To have any results, a category must contain scored questions.

You can create a new category or edit an existing one from the Metric Categories related list of a quiz record.

Select a user for a category

Category users are the recipients of the questions for each category.

A category can have one or more assigned users, and the same user can be assigned to more than one category. When the system distributes a quiz, it sends an email notification, if configured, to the category
users and creates a link to the appropriate questionnaire in their assessments and surveys portal. Users can only answer questions attached to their assigned categories.

To select users for a category, select the **Users** related list in a category record, and click **Edit**.

![Image of Users related list in category record](image)

**Create questions**

A category can have multiple questions associated with it.

Each question can only be associated with one category. Each question has an answer data type that determines how recipients answer the question. Questions are records in the Quiz view of the Assessment Metric table.

To create questions, open a category record and create a question record from the **Assessment Metrics** related list. Alternatively, you can navigate to **Quiz Management > Questions** and create a new record (see table).

**Warning:** When you create a **Choice** or **Likert Scale** question, you must reopen the Assessment Metric form after you submit it to create answers. If you distribute a questionnaire without creating the answers for questions with these data types, recipients are unable to
answer the questions. If the questions are mandatory, the recipients are unable to submit their questionnaires.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Required] Name of the question.</td>
</tr>
<tr>
<td>Category</td>
<td>[Required] Category the question belongs to. The system populates this category if you create a new question from the Metric Category form. Note: You cannot change the category if the Depends on field is set or if another metric depends on this metric.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Method</td>
<td>Setting that determines how to use the question.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Assessment</strong>: Makes the question available on a quiz distributed to users. The <strong>Assessment</strong> method is compatible with all data types except <strong>Duration</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Script</strong>: Queries the database without user participation. Scripted questions are of limited value for quizzes, because they do not assess a user's knowledge of a topic.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you select a <strong>Data type</strong> that is incompatible with the selected <strong>Method</strong>, the system automatically changes the <strong>Method</strong> to the correct value.</td>
</tr>
<tr>
<td>Weight</td>
<td>Numeric value that represents the importance of this question relative to other questions in the same category. By default, the weight is 10. For weighting suggestions, see weight categories and metrics. This field is available and required unless the <strong>Data type</strong> is <strong>Date</strong>, <strong>Date/Time</strong>, or <strong>String</strong>. These data types are not included in results calculations.</td>
</tr>
<tr>
<td>Order</td>
<td>[Required] Numeric value that determines the order of the question in the category. The question with the smallest order value appears as the first question in the category's section. By default, the order is 100.</td>
</tr>
<tr>
<td>Note:</td>
<td>It does not matter which order value you use for metrics with the <strong>Script</strong> method, because they do not appear on questionnaires.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this question appears on quizzes. If a question is inactive, it does not appear on quizzes generated after the question becomes inactive.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box for requiring users to answer the question. Users cannot submit questionnaires until they provide valid responses to all mandatory questions, which are denoted by a red field status indicator.</td>
</tr>
<tr>
<td></td>
<td>This field is available only if the <strong>Method</strong> is <strong>Assessment</strong>, the <strong>Depends</strong> on field is empty, and the <strong>Data type</strong> is not <strong>Checkbox</strong>.</td>
</tr>
<tr>
<td>Allow not applicable</td>
<td>Check box for including <strong>Not Applicable</strong> as a possible answer for this question. Users can select <strong>Not Applicable</strong> if they do not have sufficient information to respond to a question. User responses of <strong>Not Applicable</strong> are excluded from results.</td>
</tr>
<tr>
<td>Question</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Question</td>
<td>The question that is displayed in quizzes. Enter a clear, straightforward question that is easy to understand.</td>
</tr>
<tr>
<td>Details</td>
<td>Information about the question and what it evaluates. Include details that help users understand how to answer the question or when you need HTML enhanced details for your question. You can create HTML text in this field with the WYSIWYG editor, such as embedding links and images.</td>
</tr>
<tr>
<td>Depends on</td>
<td>An existing question that this question is dependent on. You can select Checkbox, Choice, Likert Scale, Template, and Yes/No questions from the same category as this question. Then use the Displayed when field to set the conditions for displaying this question. The system prevents the creation of recursive dependencies between questions. For example, if Question A depends on Question B, Question B cannot depend on Question A.</td>
</tr>
<tr>
<td>Data type</td>
<td>[Required] Format of the expected response data. See the table of data types for details.</td>
</tr>
<tr>
<td>Randomize answers</td>
<td>Check box for displaying the possible answers for this question in a random order whenever the question appears. Answer preference is sometimes influenced by the order in which answer options appear, which can result in biased results. Randomizing answer options can help prevent this bias. This check box is available only if the Data type is Choice or Likert Scale.</td>
</tr>
</tbody>
</table>

**Note:** You cannot change the data type if another question depends on this question.

**Note:** Randomizing answer options for certain questions may make those questions confusing for users. In general, only randomize answer options that do not follow a logical order.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale definition</td>
<td>Setting that determines whether lesser or greater numerical values equate to a good score in quiz result calculations. Select Low if lesser numerical values are better. Select High if greater numerical values are better. The default value is High. This field is available and required unless the Data type is Date, DateTime, or String. The results for these data types are not included in results calculations. When the Scored check box is selected, the scale value is set to High and the field is hidden.</td>
</tr>
<tr>
<td>Note: For information about how to set the scale definition for data types that do not require you to set a numerical value, see Data types for assessments.</td>
<td></td>
</tr>
<tr>
<td>Min</td>
<td>Lowest numerical value that can be used as an answer option. This field is available and required only if Data type is Number, Duration, or Percentage.</td>
</tr>
<tr>
<td>Max</td>
<td>Highest numerical value that can be used as an answer option or scaled value. This field is available and required if Data type is Number, Duration, or Percentage.</td>
</tr>
<tr>
<td>String option</td>
<td>Setting for the appearance of a string field in a question. This field is available when the question type is String. The string options are:</td>
</tr>
<tr>
<td></td>
<td>• Single line: Single line text field 40 characters in length that allows strings of any length.</td>
</tr>
<tr>
<td></td>
<td>• String line wide: Full page width text field that allows a single line entry of any length.</td>
</tr>
<tr>
<td></td>
<td>• Multiline: Full page width multiline text field that allows word wrap and returns.</td>
</tr>
<tr>
<td>Scored</td>
<td>Check box for using answers in scoring the category results and showing them in the quiz results. Scored questions are available for these data types:</td>
</tr>
<tr>
<td></td>
<td>• Choice</td>
</tr>
<tr>
<td></td>
<td>• Likert Scale</td>
</tr>
<tr>
<td></td>
<td>• Template</td>
</tr>
<tr>
<td></td>
<td>• Checkbox</td>
</tr>
<tr>
<td></td>
<td>• Yes/No</td>
</tr>
<tr>
<td></td>
<td>Selecting this check box hides the Scale definition field and sets the value in that field to High.</td>
</tr>
<tr>
<td>Correct answer</td>
<td>[Required] Desired answer to a scored question. This field is available when the Scored check box is selected. Multiple correct answers are supported for a few data types. See Data types for quizzes.</td>
</tr>
</tbody>
</table>
Create answers for questions

Questions with Choice or Likert Scale data types must have defined answer options, called metric definitions.

When you create a question with one of these data types, the Assessment Metric Definitions related list appears. Each metric definition appears as one answer option for a question on a quiz. For example, the question **What type of men's trousers are not permitted by company policy?** might have these three answers configured as metric definitions: **Slacks**, **Jeans**, and **Casual cotton**.

To create an answer option, open the question record you want to edit and click **New** in the **Assessment Metric Definitions** related list. Be sure to give each option a **Value**. The system uses this number to establish the order in which the answers appear in the quiz.

Distribute a quiz

When you finish configuring the answers for the quiz questions, you are ready to distribute the quiz.

You can send the quiz to all the category users configured for the quiz or to a single category user.

1. Navigate to **Quiz Management > Quizzes**.
2. Open the quiz record, and click **Publish**. The quiz is placed in the Published state, and it is sent to all its category users. You can edit and resend published quizzes. See **Modifying Published Quizzes** to learn how various modifications affect the quiz contents.
3. To resend a quiz, click the appropriate button:
   - **Assign Quiz**: Send the quiz to one category user.
   - **Send Quizzes**: Send the quiz to all of its category users.

**Note**: These buttons are hidden if there are no category users defined for the quiz.
Modify a published quiz
Post changes to existing questions immediately. Make new questions available to users who have not started the quiz.

You can edit a quiz even after it has been distributed, with these results:

- Added questions are available only on quizzes that are distributed after this change.
- Changes to existing questions are immediately available to users before the quiz is submitted or during the retake period. This includes changes to the answers, such as additional choices or changes to the data type.
- Deleted questions are also deleted from the distributed quizzes in users' queues.

Add a metric category and metric in the question bank for quizzes
Reuse the question categories (metric categories) and questions (metrics) added in the question bank for quizzes. You can add metric categories or metrics from the question bank to a quiz, or from the quiz to a question bank.

Role required: admin or assessment_admin

1. Navigate to Quizzes > Question Bank.
2. Click New.
3. In the Metric Category form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the metric category.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the metric category.</td>
</tr>
<tr>
<td>Total metrics</td>
<td>Total number of metrics in the metric category.</td>
</tr>
<tr>
<td></td>
<td>This number is automatically updated when you</td>
</tr>
<tr>
<td></td>
<td>add or delete metrics from the category.</td>
</tr>
</tbody>
</table>

4. Right-click on the title bar and click Save.
5. In the Assessment Metrics related list, click New.
6. In the Assessment Metric form, fill the fields. For more information on these fields, refer to Create questions.
7. Click Submit.

Configure metric categories or metrics for a quiz using the question bank
Reuse question categories (metric categories) and questions (metrics) from the Question Bank module while creating or updating a quiz.

Role required: admin or assessment_admin

1. Navigate to Quizzes > Quizzes.
2. Open a quiz definition.
3. Optional: To add metric categories to a quiz from the question bank in Platform, perform the following steps.
   a) In the Metric Categories related list, click New Category from Bank.
      The New Category from Bank dialog box is displayed with a list of all metric categories added in the question bank.
   b) Select the required categories and click Add Selected.
      A copy of the metric category and the corresponding metric definitions is created in the Metric Categories related list.
4. Optional: To add metrics to a quiz from the question bank in Platform, perform the following steps.
   a) In the Metric Categories related list, open a metric category definition.
   b) In the Assessment Metrics related list, click **New Metric from Bank**.
      The New Metric from Bank dialog box is displayed with a list of questions available in the question bank.
   c) Select the required metrics and click **Add Selected**.
      A copy of the metric and the corresponding metric definitions is created in the Assessment Metrics related list of the category.

5. Optional: To add a metric category to the question bank from a quiz in Platform, perform the following steps.
   a) In the Metric Categories related list, open a metric category definition.
   b) Click **Add to Question Bank**.
      A copy of the category is created along with its metrics and metric definitions in the question bank.

6. Optional: To add a metric to the question bank from a quiz in Platform, perform the following steps.
   a) In the Metric Categories related list, open a metric category definition.
   b) In the Assessment Metrics related list, open the required metric definition.
   c) Click **Add to Question Bank**.
      The Add to Question Bank dialog box is displayed.
   d) In the **Choose a question bank to add this question/metric** field, select a metric category that you want to add this metric to, and click **OK**.
      A copy of the metric and the corresponding metric definitions is created for the selected category in the question bank.

7. Optional: To add a metric category or metric to a quiz from the question bank in Quiz Designer, perform the following steps.
   a) Open the quiz in Quiz Designer.
   b) Optional: To add a metric category from the question bank, from the **Categories** tab in the left panel, drag the required category banner and drop in the **Design** tab.
   c) Optional: To add a metric from the question bank, drag and drop the required metric from the **Questions** tab or the **Categories** tab.

   **Note:**
   - When you drag and drop a metric category, all dependencies within the category are also added to the quiz.
   - From the **Categories** tab, you can drag and drop an individual metric within a metric category.
   - When you drag and drop a parent metric, all dependent questions are also added to the metric category.
   - When you drag and drop a child metric, only the child question is added to the metric category.

*Edit a quiz*

You can update a quiz after the quiz has been distributed.

Role required: assessment_admin or admin
You can only edit a quiz that has the same application scope as that of your current session.

- Questions that you add are available only on quizzes that are distributed after the update.
- Before a quiz is submitted or during the retake period:
  - Changes to existing questions are immediately available to users. This includes changes to the answers, such as additional choices or changes to the data type.
  - Deleted questions are deleted from distributed quizzes in users’ queues.

Open the quiz: Group the Service Details form with one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes &gt; Quiz Designer</td>
<td>Point to the menu icon in the quiz header bar and select Load Quiz.</td>
</tr>
<tr>
<td>Quizzes &gt; Quizzes</td>
<td>Right-click a quiz in the list and select Quiz Designer.</td>
</tr>
<tr>
<td>Quizzes &gt; Quizzes</td>
<td>Open a quiz from the list and click Quiz Designer in the header of the Assessment Metric Type form.</td>
</tr>
</tbody>
</table>

Configure a scored question
Only scored questions are considered when calculating category and quiz results.
Role required: assessment_admin or admin

A question must have a correct answer specified to be scored. Only results for scored questions are displayed in the quiz scorecard.

1. Navigate to Quizzes > Quizzes.
2. Open the quiz containing the questions you want to mark as scored.
3. In the Metric Categories related list on the Assessment Metric Type form, select the category for the questions you want to mark as scored.
4. In the Assessment Metrics related list on the Metric Category form, select a question from the list.
5. In the Question Type section of the Assessment Metric form, select the Scored check box.
   This check box is not available if the question’s data type is not supported for scoring.
6. Select the Correct answer for the question.
   Note: Multiple correct answers are supported for a few data types. See Data types for quizzes.
7. Click Update.
8. Repeat the process for all the questions in the category that you want the system to score.
9. Return to the list of metric categories, select another category, and configure scoring for the appropriate questions in that category.

Configure a template question
You can configure template questions when designing quizzes.
Role required: assessment_admin or admin

1. Drag the Template data type icon into a category container.
2. Click the gear icon in the question title bar to open the template properties dialog box.
3. Select a predefined scale from the list.

Question entry fields appear for that template.
4. Enter one or more questions that are appropriate for the template.
5. Click the arrow to the right of a question to configure its properties. You must provide a name for each question.

6. Click the up or down arrow to move between questions, or click the back arrow to return to the template properties dialog box.

7. Configure the properties for the remaining questions.

8. Click the X icon to close the template properties dialog box and save your settings.

Enable a quiz retake
You can configure a quiz to allow recipients to resubmit their answers as many times as they like, until the quiz’s due date.

Role required: assessment_admin or admin

Results are not calculated until the quiz’s configured duration has elapsed. The card in the user’s queue remains visible until the quiz’s due date and displays a button to allow retakes.

1. Navigate to Assessments > Metric Definition > Types.
2. Remove the Evaluation method = Assessment filter condition so you can see all the records in the list.
3. Open the quiz.
4. In the **Assessment Metric Type** form, select the **Allow retake** check box and save the record.

*View a quiz result*
You can view quiz results for each question and category, or view the quiz scorecard for a detailed breakdown.

Role required: assessment_admin or admin

Quiz results are stored in the Metric Result [asmt_metric_result] table and display recipients' answers to each question in a category.

Navigate to **Quizzes > Quiz Results.**

---

**Quiz reports**

Quizzes provide several global reports so that assessment administrators can view important statistics.

You can share these reports with specific users or groups and change the display options.

For detailed field information and reporting options, click the link for the chart **Type**. To sort a column in ascending or descending order, click the arrow in the column heading.

**Quiz reports**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes by State</td>
<td>State of distributed quizzes. This chart displays the percentage of distributed quizzes that are ready to take, in progress, complete, or canceled.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Pie Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Assessment Instance [asmt_assessment_instance]</td>
</tr>
<tr>
<td>Total Questions by Quiz</td>
<td>Total number of questions for all categories in each quiz.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Questions by Data Type</td>
<td>Total number of questions in all quizzes by data type.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Correct Answers by Assigned User</td>
<td>Total number of scored questions answered correctly by each assigned user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Number of Correct Answers</td>
<td>Total number of correct answers for each scored question.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Incorrect Answers by Assigned User</td>
<td>Total number of scored questions answered incorrectly by each assigned user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Number of Incorrect Answers</td>
<td>Total number of incorrect answers for each scored question.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
</tr>
</tbody>
</table>

View a quiz scorecard

You can view scorecards for a quiz record.

Role required: assessment_admin or admin

For detailed information about scorecards, see Quiz scorecards.

1. Navigate to **Quizzes > Quizzes**.
2. Open a quiz record.
3. Under **Related Links**, select **View Scorecard**.

   The scorecard link is hidden if there are no quiz results to report.

4. The scorecard contains a header that displays the name of the quiz and a section that displays results or a comparison of ratings. You can select from these principal views:
   - Category Results
   - Question Results
   - Average Ratings
   - History

Quiz scorecards

The Quizzes application prepares printable scorecards.
A scorecard analyzes category and question responses and compares current ratings with previous ratings. You can examine ratings over time, compare question ratings, or compare the ratings of all categories. All ratings are averages for the time range selected.

The system dynamically updates a scorecard each time you view it, so the ratings reflect recently completed quizzes.

Category results
The Category Results view is a stacked bar chart of responses to all questions in a category.

Select the category to display from the choice list above the chart. Category results are only calculated for scored questions.

This view displays responses that use the following data types:

- Checkbox
- Choice
- Likert Scale
- Number
- Template
- Yes/No

Note: The Checkbox and Yes/No data types are combined into the Boolean data type in the Quiz designer.
Quiz category results
To view details about a specific response to a question, point to the colored segment representing a specific response. The chart displays the count for those responses and the percentage it represents of the total responses to that question.

**Quiz category result details**

**Question results**
The Question Results view shows the results for all questions in a quiz.
Select a question by name from the choice list to display the results in a pie chart or a bar chart, based on the data type.

**Pie chart**
The pie chart shows question results for these data types:
- Checkbox
- Choice
- Likert Scale
- Number
- Template
- Yes/No

**Note:** The Checkbox and Yes/No data types are combined into the Boolean data type in the Quiz designer.
Quiz scorecard question results - pie chart
Bar chart

A bar chart appears when question results use this data type:

- Percentage

By default, all results for percentage questions use a report range of 20% segments. To configure a report range, navigate to Reports > Administration > Report Ranges.

Average ratings

The Average Ratings view displays a bar chart of the weighted average rating for each question in a category.

Use this view to learn how individual questions affect the overall rating for the category. Select a category from the second choice list above the chart. Ratings are only calculated for scored questions.
Average Ratings view

To view the effect of each question's ratings on the entire category's ratings, point to the colored bar. The pop-up box shows the percentage of the total ratings represented by each individual question's weighted average.
Scorecard history

The History view compares the current ratings for the categories and their questions with ratings from the previous three years or four quarters.

Ratings that have declined are highlighted in red and display negative numbers. Ratings that have improved are highlighted in green with positive numbers. Arrow icons beside the values in the **Diff** column indicate the trend of the current ratings against the previous ratings. Ratings are only calculated for **scored questions** questions.

Point to a category to display a line chart that shows the rating trend for that category. Click a category to view the Metric Category form containing the questions.

- **3 Years**: To calculate the current ratings, the system averages the ratings from the trailing twelve month (TTM) period. The **Diff** column shows the discrepancy between the current ratings and the previous calendar year's ratings.
### Quiz Scorecard

<table>
<thead>
<tr>
<th>Question</th>
<th>Current</th>
<th>Diff</th>
<th>2013</th>
<th>2012</th>
<th>2011</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Rating</td>
<td>14.81</td>
<td>14.81</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Dress Code</td>
<td>19.45</td>
<td>19.45</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Sexual Harassment</td>
<td>12.50</td>
<td>12.50</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Company Property</td>
<td>12.50</td>
<td>12.50</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**Scorecard history - 3 years**

- **4 Quarters**: Quarterly quizzes compare the average rating for each question and category in the current quarter against the average ratings from the previous four quarters. The **Diff** column shows the discrepancy between the current ratings and the previous quarter's ratings. The column labels count backward, by quarter from the current quarter. For example, if the current quarter is the 3rd quarter of 2013, then the previous quarters appear as 2nd [2013], 1st [2013], 4th [2012], and 3rd [2012]. All four of the previous quarters appear, whether or not there was any data for those quarters.
Scorecard history - 4 quarters

View an assessment category result
Category results contain values that represent an evaluated record's performance in a specific metric category. Each category result record stores data from one assessment group. Category result values are calculated based on category and metric weights and from metric result values for the same category.

Role required: assessment_admin or admin

Note: The system does not include metric results from certain responses in category result calculations. To compensate, the system adjusts the weight of the other normalized metric result values within the same category.

1. Navigate to Assessments > Results > Category Results.
2. Click the reference icon (Play) next to an assessment group number to open the category result record.

![Assessment Category Results](image)

- **All**: Type Evaluation method = Assessment > Category != NPS category > Assessment group = ASG0000801 > Source = 5f747
- **Assessment group**: ASG0000801
- **Category**: Recommendation
- **Weight**: 7
- **Source**: Group: NY DB
- **Rating**: 9.25
- **Normalized value**: 2.94

![Assessment Category Results](image)

- **Assessment group**: ASG0000801
- **Category**: Responsiveness
- **Weight**: 10
- **Source**: Group: NY DB
- **Rating**: 9.16
- **Normalized value**: 4.16

![Assessment Category Results](image)

- **Assessment group**: ASG0000801
- **Category**: Politeness
- **Weight**: 5
- **Source**: Group: NY DB
- **Rating**: 8.86
- **Normalized value**: 2.01

3. View the Assessment Category Result form.
   All fields on the form are read-only.

**Assessment Category Result form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Name of the metric category that the category result values apply to.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Rating</td>
<td>Rating is used on scorecards and decision matrixes. Rating is updated dynamically as users complete assessments. Rating is calculated as:</td>
</tr>
</tbody>
</table>

\[
\text{Rating} = \frac{\text{Sum of all normalized values that share a particular assessment group, category, and assessable record}}{\text{Number of assessment instances for the assessment group}}
\]

For example: In the Assessment Category Results table example, the assessment group ASG0000801 with category Politeness from group NY DB (the assessable record) has a Rating value 8.86.

On the associated Metric Results table, you can see that there are 4 instances of this group: AINST0000801, AINST0000802, AINST0000803, and AINST0000804.

The system calculated the rating using

\[
\frac{5.14+5.14+1.43+5.71+5.14+4.29+4.29+4.29}{4} = 8.86
\]
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment group</td>
<td>Assessment group to which the category result is associated. The category result <strong>Rating</strong> and <strong>Normalized value</strong> are calculated from metric results in this assessment group only.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>Calculated value that measures the <strong>Rating</strong> relative to the weights of categories used to assess the record evaluated.</td>
</tr>
<tr>
<td></td>
<td>The normalized value is calculated as follows:</td>
</tr>
<tr>
<td></td>
<td>Normalized value = Rating x (Associated category weight / Sum of weights of all categories the source record has category results for in this assessment group)</td>
</tr>
<tr>
<td></td>
<td>Example: A source record has four associated category results in assessment group ASG0000907, one for each of these categories:</td>
</tr>
<tr>
<td></td>
<td>• Importance Rating (weight = 10)</td>
</tr>
<tr>
<td></td>
<td>• Product Reliability (weight = 9)</td>
</tr>
<tr>
<td></td>
<td>• Company Alignment (weight = 9)</td>
</tr>
<tr>
<td></td>
<td>• Compliance Score (weight = 9)</td>
</tr>
<tr>
<td></td>
<td>If this source record’s category result for Product Reliability has a Rating of 7.81, the normalized value calculation is:</td>
</tr>
<tr>
<td></td>
<td>7.81 x [9 / (10+9+9+9)] = 1.9</td>
</tr>
<tr>
<td>Weight</td>
<td>Weight of the associated category. You may need to configure the form to see this field.</td>
</tr>
<tr>
<td>Source</td>
<td>Record evaluated as the assessment subject. You may need to configure the form to see this field.</td>
</tr>
</tbody>
</table>

**Create a decision matrix**

The name and labels on a decision matrix are closely linked to the categories you choose for the axes. For that reason, first select the metric type and define the X and Y axes before you fill in other fields on the Decision Matrix form.

Role required: assessment_admin or admin

1. Navigate to **Assessments > Admin > Decision Matrixes**.
2. Click **New** and then select the metric **Type** to plot results for.
3. Right-click the form header and select **Save**.
   The X Axis and Y Axis related lists appear.
4. Define which metric categories the axes represent. Each axis can represent a single category or multiple categories. You must specify at least one category per axis in order for the decision matrix to render properly.

The available categories are limited to those associated to the metric type selected. To avoid confusion, always update the text for the axis and quadrant labels after editing or adding metric categories to an axis.

Decision matrix axes
5. Fill in the remaining fields on the Decision Matrix form (see table) and save the record.
**Decision Matrix form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name of the decision matrix, which appears as the title on the decision matrix page. It is recommended to include the axis categories in the name. For example, if you selected <strong>Importance Rating</strong> as the X-axis and <strong>User Satisfaction</strong> as the Y-axis, you might name the matrix <strong>Importance vs. User Satisfaction</strong>.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Metric type associated with this decision matrix. Only results for assessable records of the selected metric type are plotted on the decision matrix.</td>
</tr>
<tr>
<td><strong>Default</strong></td>
<td>Determines whether or not this is the default decision matrix. The default decision matrix opens when you click <strong>View Matrix</strong> on a scorecard. Select the check box to set the matrix as the default decision matrix. The system prevents you from creating more than one default decision matrix per metric type. If there is already a default decision matrix for the type and you try to save a different matrix with the check box selected, an error message appears. The maximum values for the default decision matrix are controlled by the <strong>Maximum number of items to show for a decision matrix field filter</strong> property (com.snc.assessment.decision_matrix_filter_max_entries), which has a default value of 1000.</td>
</tr>
</tbody>
</table>

**Quadrant Design Section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quadrant label color</strong></td>
<td>Color of the label text for the quadrants. Each quadrant label displays in the center of the quadrant. You can enter an HTML color name or hex value for this and the other color fields.</td>
</tr>
<tr>
<td><strong>X-Axis label</strong></td>
<td>Label text for the X-axis of the decision matrix. It is recommended to include the metric category name in the label text. For example, for an X-axis category of <strong>Importance Rating</strong>, the X-axis label is <strong>Importance</strong>.</td>
</tr>
<tr>
<td><strong>Plotted item color</strong></td>
<td>Color used to display plotted items.</td>
</tr>
<tr>
<td><strong>Top left label</strong></td>
<td>Label text for the top left quadrant. For an X-axis labeled <strong>Importance</strong> and Y-axis labeled <strong>Support</strong>, you might label the top left quadrant <strong>Low importance, high support</strong>.</td>
</tr>
<tr>
<td><strong>Top left color</strong></td>
<td>Fill color for the top left quadrant.</td>
</tr>
<tr>
<td><strong>Bottom left label</strong></td>
<td>Label text for the bottom left quadrant.</td>
</tr>
<tr>
<td><strong>Bottom left color</strong></td>
<td>Fill color for the bottom left quadrant.</td>
</tr>
</tbody>
</table>

**Note:** For color fields, either HTML color names or hexadecimal (hex) values are acceptable. For hex values, the # character is optional. Values are not case-sensitive. For example, all of the following values are valid: LightGray, lightgray, #D3D3D3, d3d3d3.
### Field | Description
--- | ---
Bottom left label | Label text for the bottom left quadrant.
Bottom left color | Fill color for the bottom left quadrant.
Y-Axis label | Label text for the Y-axis of the decision matrix.
Highlight item color | Color of highlighted plotted items. When you view a decision matrix from an assessable record's scorecard, the assessable record plotted item appears in the highlight color. Specify a highlight color that is different than the **Plotted item color**.
Top right label | Label text for the top right quadrant.
Top right color | Fill color for the top right quadrant.
Bottom right label | Label text for the bottom right quadrant.
Bottom right color | Fill color for the bottom right quadrant.
Related Lists
X Axis | Lists categories that define the X-axis of the decision matrix.
Y Axis | Lists categories that define the Y-axis of the decision matrix.

**Decision matrixes**  
Assessment results obtained by questionnaires and scripted metrics can be mapped to decision matrixes.  
Assessment administrators can view and create these dynamically updated graphs, which make it possible to compare assessable records by category. Decision matrixes display data from a trailing twelve month (TTM) period.

**Note:** Assessment administrators can access decision matrixes through the Assessment application and vendor managers can access them through the Vendor Performance application.

### Decision matrix components  
The decision matrix page has these components:
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Select the subset of assessable records you want to view. The filter options available vary by metric type, based on the Filter field and Filter condition field settings for each type. The maximum values in the filter are controlled by the Maximum number of items to show for a decision matrix field filter property (com.snc.assessment.decision_matrix_filter_max_entries), which has a default value of 1000.</td>
</tr>
<tr>
<td>Scale</td>
<td>Select the scale for the decision matrix. The greater the scale, the larger the decision matrix appears.</td>
</tr>
<tr>
<td>Decision matrix</td>
<td></td>
</tr>
<tr>
<td>X- and Y-axes</td>
<td>Each axis represents one or more metric categories. If multiple categories are used for an axis, their respective weights determine the positioning of the plotted items.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Plotted items</td>
<td>The labeled points you see on a decision matrix, called plotted items, represent averages of <strong>category result</strong> data for assessable records. Point to a plotted item label to view a rating summary for that assessable record. Click a plotted item label to view the <strong>scorecard</strong> for the assessable record.</td>
</tr>
</tbody>
</table>
Plotted item rating summaries

If you point to a plotted item label on a decision matrix, a rating summary appears. The summary displays the assessable record's average ratings for each axis. If an axis represents one metric category, the ratings are calculated averages from results for that category. If an axis represents multiple categories, the ratings are calculated averages from weighted results for all of the categories.

The summary shows:

- Current rating
- Difference between the current rating and the rating from the previous year
- Ratings from each previous year, going back three years

Take an assessment

Assessments that are assigned to you appear in your assessment and survey queue as a card that displays the assessment name, state, due date, and the associated incident number. Click Take Survey when you are ready.

Role required: none
Overdue surveys and assessments are marked with a red icon and red due date. You must answer every required question, indicated by a red bar, before you can submit the assessment as complete. If you start to take an assessment but cannot complete it, save your responses and return to it later. When you have answered all the questions and are satisfied with the responses, submit the assessment.

By default, you cannot modify your answers to an assessment after submission. However, if the administrator has configured an assessment to allow retakes, you can edit your answers and resubmit the questionnaire. Completed assessments configured for retake remain in the queue until their due date and display the Modify Assessment button on the card.

1. Navigate to Self-Service > My Assessments & Surveys.

   **Note:** Users with the assessment_admin role can display other users’ assessments and surveys in addition to their own. Use the Show all and Show assigned to me related links to show and hide assessments and surveys. Click a card assigned to another user to open the associated metric type or survey definition.

2. On the assessment card, note the due date.

   **Note:** Depending on the configuration, you may receive email notifications to remind you of the due date.

3. Click Take Assessment to open the questionnaire.

   Assessment questionnaires are arranged in sections: first by record, then by category. Each record appears as a section title. Questions for the record appear below, grouped by category. Each category appears as a subsection below the record name. Click the collapse icon (��) or expand icon (觀) to
hide or show the questions in a category, or all the categories and questions for a record. Colored bars indicate the status of each question.

4. Answer each question to the best of your ability. Point to a question for more information.

If you are unsure of how to respond to a question or if a question does not apply to a particular record, select Not Applicable, if available.
5. Read any assertions present at the end of the assessment and acknowledge with a signature, if required.

A signature can require you to select a check box or authenticate your full name, which the system displays in a read-only field. You cannot submit your answers to the assessment until you provide the required signature.

6. Save or submit the assessment.
   - **Save**: Saves your responses without submitting them. You can close the questionnaire and access it later from your queue.
   - **Submit**: Submits the completed assessment when you are finished.

7. If prompted, enter your user name and password to verify your full name signature.

If all the questions are answered with valid values, a success message appears. If the system detects an unanswered mandatory question or invalid response, the assessment is not submitted, and a message appears at the top of the questionnaire explaining the error. Questions with problems are temporarily highlighted.
8. You can modify your responses to the assessment until its due date. To update your answers and resubmit an assessment that permits retakes, click **Modify Assessment**.

**Assessment questionnaires**

In the assessment process, users complete assessment questionnaires on topics of interest to provide subjective data for future business decisions.

No special role is required to complete an assessment. You are eligible to complete assessments that are assigned to you. For example, you might be expected to evaluate vendors your organization works with, based on traits related to customer service. The system stores your responses so decision makers can compare the performance of the items you evaluate. You and your manager may receive email notifications as reminders of important assessment information.

**Metric types and assessable records**

In the Assessments application, assessment administrators create and administer metric types and assessable records.

A metric type defines a set of records an organization wants to evaluate, such as vendors, projects, or employees. For each type, the system generates unique assessable records that link the type to records that need to be evaluated, such as the individual records for the vendors Amazon and Intel. There may be multiple assessable records for the same source record if the source record meets the criteria for more than one type. For example, you might want to evaluate a record on the Company table, such as Intel, as a vendor and as a manufacturer, with different categories and metrics.

For configuration suggestions, see **Assessment administrator tasks**.

**Assessable records**

An assessable record links a source record you want to evaluate, such as the company record for Amazon or the user record for a sales representative, to a metric type, such as vendors or employees.

You use assessments to evaluate the assessable record. The system generates assessable records from the source records that match the table and conditions set on the Assessment Metric Type form. You evaluate the assessable records with metric categories and metrics, which define traits and values to assess. For metric types with the **On demand** schedule type, you can generate on-demand assessments from the Assessable Record form. This method of assessment generation makes it easy to create and preview short questionnaires or to quickly obtain assessment results for specific assessable records.

You can set up an assessment description that includes information from multiple fields on an assessable record and is displayed on multiple lines. This set up provides the user who is taking the assessment with a more detailed and understandable description of the information being requested on the assessment questionnaire. Create a multi-line description using table titles, which can be defined to use one or more fields from the selected table. See **Customize the mobile list title** for more information.

**Delete an assessable record**

When you delete an assessable record, the system deletes any stakeholders for the record.

Role required: **assessment_admin** or **admin**

**Note:** If a source record is deleted, the system deletes the associated assessable record. To delete the source record, you must first delete all associated metric results and category results.

Delete the assessable record:

- To delete a single record, open the record and click **Delete**.
• To delete multiple records, use the Assessable Records list.

View an assessable record

View the Assessable Record form to edit preferences and perform various actions.

Role required: assessment_admin or admin

1. Navigate to Assessments > Assessable Records.
2. Open a record from the list.
   By default, the list displays only assessable records with Active metric types.
3. On the Assessable Record form, edit fields and perform other actions as necessary (see table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Read-Only] Assessable record name based on the display value of the source record. The name appears on assessment questionnaires.</td>
</tr>
<tr>
<td>Source</td>
<td>[Read-Only] Source record the assessable record is linked to. The Source reflects the table name and source record display value. For example, if the Name field is the display value for the Company table, the assessable record for a company record named Amazon has the Source value Company: Amazon.</td>
</tr>
<tr>
<td>Live feed</td>
<td>Check box that, when selected, creates a live feed group for the assessable record, which appears on the scorecard. If you clear the check box after a live feed group has been created, the system deletes the live feed group and all its messages.</td>
</tr>
<tr>
<td>Type</td>
<td>[Read-Only] Metric type from which the assessable record was generated.</td>
</tr>
<tr>
<td>Decision matrix</td>
<td>Check box that, when selected, enables this assessable record's results data to appear on decision matrixes of the same metric type. Decision matrixes are graphs that plot the assessment results for multiple assessable records. If you clear the check box, the assessable record still appears on the default decision matrixes if you click the View Matrix related link on the assessable record's scorecard.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Live feed group</td>
<td>[Read-Only] Live feed group for this assessable record. When you select the Live feed check box and save the record, the system populates this field.</td>
</tr>
<tr>
<td>Related Links</td>
<td></td>
</tr>
<tr>
<td>View Scorecard</td>
<td>Opens the scorecard for the assessable record.</td>
</tr>
<tr>
<td>Related Lists</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>All metric categories associated with the assessable record. An assessable record must be associated to a category to be evaluated. Click Edit to add or remove category associations. Note that it is often more efficient to associate assessable records to categories using the Metric Category form.</td>
</tr>
<tr>
<td>Category users</td>
<td>All stakeholders who can take assessment questionnaires about this assessable record. Click Edit to create and delete stakeholders. For more information about this and other methods of creating stakeholders, see Stakeholders. This related list is available only when the associated metric type has the Scheduled schedule type.</td>
</tr>
</tbody>
</table>

## Domain separation and Assessments

This is an overview of domain separation and Assessments. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

### Overview

**Support: Level 2**

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

As an assessment creator, assessment_admin can create or edit an assessment in their assigned domain. A Global domain assessment_admin can create or edit assessment in any domain.

As an assessment taker, a user in a particular domain can see assessable records in the Global domain, in the user's domain, and in any child domains. Users in the Global domain can see all assessable records.

### How domain separation works in Assessments

If the metric type is global:

- All the categories and metric should be Global
- Assessable records can be from different domains
- When the assessment is assigned to a user, then:
  - Users in the Global domain can see all assessable records
  - Users in a particular domain can see assessable records in the Global domain, in their domain, and in any child domains
  - If the user does not have access to any of the assessable records (for example, the metric type is Global, but all assessable records are in Acme domain and a user in the XYZ domain is assigned the assessment), the assessment instance is not created and an “Instance could not be created” error message occurs.

If the metric type is not Global:
  - All categories and metrics must be in the same domain as the metric type
  - All assessable records must be in the same domain as the metric type
  - You can assign assessments to users that are in the Global domain, in the domain of the metric type, or in any parent of the domain of the metric type

**Approvals**

Require authorization on tasks before the work is done. You can define approvals for all tasks and associate users or groups to a task to approve or reject them.

Approvals are defined by navigating to System Policy > Approvals.

The following information defines an approval:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approver</td>
<td>A reference to the user who is responsible for approving the related record.</td>
</tr>
<tr>
<td>State</td>
<td>Choices are:</td>
</tr>
<tr>
<td></td>
<td>• Not Yet Requested (This state indicates that you are not yet asking your approvers to approve this request. Until you set the status to Requested they will receive no email notifications about the request.)</td>
</tr>
<tr>
<td></td>
<td>• Requested</td>
</tr>
<tr>
<td></td>
<td>• Approved</td>
</tr>
<tr>
<td></td>
<td>• Rejected</td>
</tr>
<tr>
<td>Approving</td>
<td>A document_id reference field to the record being approved, on any table.</td>
</tr>
<tr>
<td>Comments</td>
<td>A journal field for storing comments regarding the approval.</td>
</tr>
<tr>
<td>Approval Summarizer</td>
<td>A formatter that displays key fields relevant to the approval from the referenced document. This summarizer will not display if there is no record referenced.</td>
</tr>
</tbody>
</table>
Approval engines

The differences in the way that companies handle their approvals, as well as the differences between approvals for the various applications (such as Service Catalog Requests and Change Management), calls for supporting flexibility in setting up approvals within applications. This flexibility is provided through the selection of an "approval engine" that is used to manage the approvals for each of the Task tables (that is, all tables that extend the Task table).

There are three different approval engine options available for each Task table.

**Approval engine options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Rules</td>
<td>A simple set of rules that are evaluated until one matches for the Task table. The matching approval rule is used to create the users that are to approve the task. Set up approval rules by navigating to <strong>System Policy &gt; Approvals</strong>.</td>
</tr>
<tr>
<td>Process Guides</td>
<td>A sequence of approval steps over which you may control how approvals and rejections are handled. This option is deprecated and should not be used.</td>
</tr>
<tr>
<td>Turn off Engines</td>
<td>Turn off both approval engines for this Task table. This option should be selected and is made read-only when a workflow is used to manage the approval process for the table. <strong>Caution:</strong> Not turning off the approval engines might have a performance or behavioral impact on your instance.</td>
</tr>
</tbody>
</table>

Set up an approval engine

To manage the approvals for each of the Task tables in the system, set up an approval engine.

1. Navigate to **System Properties > Approval Engines**.

   The following page appears with the **Approval Engine** option for each Task table in the system. If the **Approval Engine** option is greyed out and shows **Turn engines off**, read the **Notes** in the same row. The most common reason an approval engine is turned off is that a workflow is managing the approvals on the table. Having the approval engine turned off prevents conflicts with the workflow that
could cause a range of issues. If you want to use an approval engine on the table, set the workflow to inactive.

2. Select the approval engine option for each Task table from the choice list.
3. Click Save.

These preferences are saved as system properties that are named glide.approval_engine.<table_name>.
Approval rules

Many organizations rely on an approval process to ensure that requests are reasonable and fit an organization's budget.

The service catalog can use these classes of approvals:

<table>
<thead>
<tr>
<th>Approvals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gating approvals</td>
<td>Must occur before a request can be initiated. For example, allow a manager to reject an employee's request for a company car.</td>
</tr>
<tr>
<td>Process approvals</td>
<td>Take place within an execution plan process that has been initiated. For example, allow the security group to reject a request for access to SSN even though the employee's manager approved it.</td>
</tr>
</tbody>
</table>

Note: To enable approval processes to operate smoothly, make sure that the appropriate users have the correct role, and that the role grants access to the necessary tables for users in all the relevant departments and domains.

Set automatic approval rules

Approval rules can automatically set the approval state to something other than Not yet requested. As a result, an approval rule can create a set of approvers. You can also start the approval process by setting the approval state to Requested.

Prerequisites

Role required: admin

Approval rules have two new fields:

- Run rule before: If true, the approval rule runs before the record is inserted/updated.
- Set State: If this rule applies, then the task record's approval state is automatically set to this value.

Note: The Set State field only behaves as expected if the Run rule before check box is enabled.

• In the example below, this rule automatically sets the state of the task to Approved thereby auto-approving the task.
Gating approvals

A gating approval acts as a gate through which a request must pass before it can start. Until all gating approvals are met, no notifications go out, no tasks get sent to technicians, and nobody starts working on the request in question.

Generate gating approvals with:

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval rules</td>
<td>Can apply to the service catalog as well as any other task table.</td>
</tr>
<tr>
<td>Item-based approvals</td>
<td>Flag specific catalog items as requiring specific approvals. Any requests for these items automatically require these approvals.</td>
</tr>
</tbody>
</table>

Set up a gating approval via an approval rule
You can set up a gating approval via an approval rule.

Role required: admin

1. From the left navigation pane, select **System Policy > Approval Rules**.
2. Click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of this rule.</td>
</tr>
<tr>
<td>Table</td>
<td>Task table to which this rule applies. For most service catalog approvals, select Request. Note: The list shows only tables and database views that are in the same scope as the approval rule.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicator of whether the rule is active (defaults to true).</td>
</tr>
<tr>
<td>Run Rule Before</td>
<td>Indicator of whether the rule runs before or after the request record is saved. For most approvals, select this check box.</td>
</tr>
<tr>
<td>User</td>
<td>User who must approve this request (can be empty).</td>
</tr>
<tr>
<td>Group</td>
<td>Group that must approve this request (can be empty).</td>
</tr>
<tr>
<td>Set State</td>
<td>Value of the approval field on the task in after this rule runs. In most cases, select Requested.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition under which the rule applies.</td>
</tr>
</tbody>
</table>
### Field: Script

An optional server script to programmatically specify who the approver should be. For example, for the one-line script `current.requested_for.manager`, ServiceNow checks the `requested_for` reference field on the current record. It then locates the manager field on the referenced record and assigns that person as the approver. For other examples, see the Script field on approval rules provided by ServiceNow.

---

**Notes and limitations:**

- **a.** You can have as many rules as you want on a given table. If more than one rule applies, you'll get more than one approver.
- **b.** You can't get duplicate approvers, for example, if two rules both want Fred Luddy to approve a particular request, the system will only create one approval entry for him.
- **c.** By default all requests start out in a **Not yet requested** approval state. Approval notifications will not go out until the request's approval state is set to **Requested**. You can do that manually, or you can do it in script, but the easiest way to do it is to use the **Set State** field to automatically set the request to **Requested**.

---

**Set up a gating approval based on the item being ordered**

In addition to adding approvals via approval rules, you can also add approvals based on what kind of item is being ordered.

In addition to adding approvals via approval rules, you can also add approvals based on what kind of item is being ordered. We can, for example, specify that all Blackberrys need to be approved by David Loo.

To do so, navigate to the item in question and scroll to the related list of required approvers. There are two lists:

- **Approved By Group:** A list of groups that have to approve requests for this item
- **Approved By:** A list of users who have to approve requests for this item
In the example above, this request must be approved by all members of the Hardware group and by David Loo.

Notes and limitations:

1. As with approval rules, you are protected against duplicate entries. Thus if David Loo is a member of the hardware group, as well as being a standalone approver, he will only get one approval request.
2. Item-based approved work in addition to rather than instead of approval rules so you can (and probably will) use both.

Process approvals

Once a request has passed its gating approvals, any relevant execution plans are initiated. Those plans, in turn, create a sequence of required tasks. You can add an approval step to an execution plan, which is configured to occur at the appropriate point.

From the left navigation pane, select **Service Catalog > Execution Plans**, and then select the plan to which to add an approval step. Then click the **New Approval** button.
The Approval Task screen appears. Just like a regular Service Catalog execution task, an approval execution task has:

- **Name**: The name of this task
- **Order**: Sequence of this task within the plan
- **SLA**: SLA to which this task applies
- **Delivery Time**: Time allowed for the completion of this task

After you create the task, right click the title bar and select **Save**. Two related lists appear at the bottom of the screen:

- **Approved By Group**: A list of groups that must approve the request before this task is complete
- **Approved By**: A list of users who must approve the request before this task is complete

In the example above, this security approval task must be approved by Fred Luddy.
Approve with a process guide

Process guides work similarly to approval rules in that their execution is controlled via a condition. The default version of approval tasks allows you to specify that the approval in question be approved by:

1. One or more specific people
2. One or more groups of people

You can optionally use Process Guides instead of approval tasks. Process guides are more flexible in that they allow for:

1. "Any of" or "All of" approvals
2. Sequenced approvals

You can link a process guide to an execution task.

1. From the left navigation pane, select System Policy > Process Guides.
2. Create a new guide.
3. Set the table to Catalog task.
4. Fill in a condition under which this guide should attach.

Example #1: Apply to all "Capacity Review" tasks.

```
Add Condition
-  + State is Open
-  + and Delivery task is Capacity Review
```

Example #2: Apply to all "Capacity Review" tasks where there requester is in Atlanta.

```
Add Condition
-  + State is Open
-  + and Delivery task is Capacity Review
-  + and Request item.Requested For Location is Atlanta
```

Process guide tips and tricks:

a. All catalog tasks are generated when a request is first submitted, but tasks which aren't active yet have a state of "pending". So if you do not want to send out approval requests until a task has actually started, add "state=open" as part of your condition.

b. There is a "Default" process guide in the system for catalog tasks with a sequence number of 10,000. It behaves exactly the same way the old, pre-process guide code did in regards to approvals. Approvals are based on the execution of task-related lists.
Schematic of a hypothetical approval process

In the diagram below of a hypothetical approval process, the gating approval is color coded blue and an in-process approval is orange.

Approval process

Approval summarizer formatter

The approval summarizer formatter creates the summary at the bottom of an approval form.

The approval summarizer displays different information depending on what is being approved, such as a change request or a service catalog request. Following are two examples.
Summary of Item being approved

Change Request

<table>
<thead>
<tr>
<th>Number</th>
<th>CHG0000001</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested by</td>
<td>David Loo</td>
</tr>
<tr>
<td>Affected CI</td>
<td>Sales Force Automation</td>
</tr>
<tr>
<td>Type</td>
<td>Normal</td>
</tr>
<tr>
<td>Risk</td>
<td>High</td>
</tr>
<tr>
<td>Impact</td>
<td>3 - Low</td>
</tr>
<tr>
<td>Planned start date</td>
<td>2016-07-27 16:00:00</td>
</tr>
<tr>
<td>Planned end date</td>
<td>2016-07-27 18:00:00</td>
</tr>
<tr>
<td>Description</td>
<td>Rollback Oracle Version</td>
</tr>
<tr>
<td>Short description</td>
<td>Performance of the Siebel SFA software has been severely degraded since the upgrade performed this weekend. We moved to an unsupported Oracle DB version. Need to rollback the Oracle instance to a supported version.</td>
</tr>
</tbody>
</table>
Summary of a catalog request

The **Reject** button allows the approver to deny one or more requested items in a multi-item request, before approving the overall request. If a requested item is denied, the workflow for that item never starts. The approver can then choose to **Accept** the item.

**Note:** When the overall request is approved, you must ensure this **Reject** button is hidden. If this button is used after request approval, the requested item workflow is canceled, leaving the stage in an inconsistent state. Similarly, the **Accept** button on requested items should only appear before the overall request is approved or rejected.

Summarizers

Approval summarizers are stored in the Macro [sys_ui_macro] table.

From the left navigation pane, select **System UI > UI Macros**. Summarizers use a naming convention of approval_summarizer_+ '
<table_name> (for example, approval_summarizer_change_request is the summarizer for change requests, while approval_summarizer_sc_request is the summarizer for service catalog requests).

Each summarizer is written in Jelly script, which is used to define internal forms. The script is stored in the large XML field at the bottom of the UI Macro form.

*Change an approval summarizer*

You can modify existing approval summaries to include additional information.

These are advanced customizations that might not be appropriate for all implementations, and require creating a custom form.

1. Navigate to **System UI > UI Macros**.
2. Open the summarizer you want to change.
3. Copy the script to another location before editing, in case you need to revert it.
4. Modify the script.
5. Click **Update**.

*Create a new custom approval summarizer*
After you add a new table that has approvals to an instance, you can add a custom activity formatter by creating a new UI macro and then add it to the appropriate form.

approval_summarizer can only be used on approval forms in the global scope.

1. Navigate to **System UI > UI Macros**
2. Click **New**.
3. Give the macro a name that follows the summarizer naming convention:
   approval_summarizer_<tablename>
4. Complete the rest of the form and click **Submit**.
5. **Create an activity formatter** and add it to the appropriate form.

To learn more about activity formatters, see [Activity formatter](#).

### Approval with e-signature

Approval with e-signature allows users to approve requests by re-entering their login credentials.

Approval with e-signature supports the following authentication credentials:

- User name and password matching a user in the local database.
- User name and password matching a user authorized by an external identity provider as part of a SAML 2.0 single sign-on integration.

### Activate Approval with e-Signature plugin

The Approval with e-Signature plugin (com.glide.e_signature_approvals) allows users to approve requests by re-entering their login credentials.

Role required: admin

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### De-activate e-signatures

Use this procedure to de-activate e-signatures.

Although plugins cannot be removed, e-signatures can be disabled.

1. Navigate to **System Definition > E-Signature Registry**.
2. Set **Enabled** to **False** on any tables where e-signatures are no longer required.

### Use e-signature approvals

Users can approve requests with an e-signature.
Users can approve requests with an e-signature by:

- Selecting the **Approve** or **Reject** option on a list context menu.
- Clicking the **Approve** or **Reject** button on a form.
- Changing a request record's **State** to **Approved** in either the list-editor or form.

Selecting any of these options presents the user with an Approver Authentication window, which requests the user's credentials again.

**Installed with approval with e-signature**

Installing approval with e-signature installs certain properties.

- Module - E-Signature Registry
- UI Action - Approve (on table sysapproval_approver, with no action name)
- UI Action - Approve (on table sysapproval_approver, with no action name)
- UI Action - Approve (on table sysapproval_approver, with the action name authenticated_list_approval)
- UI Page - form_login_validate_dialog
- UI Page - login_validate_dialog
- UI page: saml2_esignature_login, the re-authentication page that appears when an approver tries to approve a request.
- Properties: see E-signature SAML properties
- Client Script - Authenticate Approver
- Script Include - User
- Script Include - UserAuthentication
- Processor: eSigSaml2AssertionConsumer

Installing the plugin also disables the two out-of-the-box Approve UI Actions on the **sysapproval_approver** table.

**Select an approval table**

By default, activating the Approval with E-signature plugin enables e-signature for all tables for which a previous approval exists.

E-signature approvals can also be enabled on a table-by-table basis. To enable e-signatures for a table:

1. Navigate to **System Definition > E-Signature Registry**.
2. In **Table name**, use the drop-down list to select a specific table.

<table>
<thead>
<tr>
<th>Table Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Table</td>
</tr>
<tr>
<td>Enabled</td>
</tr>
</tbody>
</table>

**Set up an approval from a local database**

Enable users to authorize e-signature approvals using local database credentials.

1. Activate the **Approval with e-signatures** plugin.
2. Create user records for approval users.
Use Multi-Provider SSO to set up an SSO approval for a SAML 2.0 authentication

An SSO approval with e-signature requires configuration on the SAML IdP and the ServiceNow instance.

The SAML IdP must support and honor the forceAuthn attribute in SAML assertion requests. E-signature does not function without this IdP setting. To set up an approval with e-signature using credentials from a SAML 2.0 authentication:

1. Activate or upgrade to SAML 2.0 with the Integration - Multiple Provider Single Sign-On Installer plugin.
2. Activate the Approval with E-Signature plugin.
3. Navigate to Multi-Provider SSO > Identity Providers and verify your 2.0 SAML IdP configuration Advanced tab shows the Force AuthnRequest attribute checked. Your SAML 2.0 IdP must support the Force AuthnRequest attribute, or e-signature is not supported.
4. On the eSignature Approval tab, enter the following e-signature SAML properties:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assertion Consumer URL for eSignature authentication</td>
<td>This property defaults to the appropriate URL. To configure this property, click the lock icon to make this field editable. After edits, click the icon to lock the field.</td>
</tr>
<tr>
<td>Assertion Consumer Index for eSignature authentication</td>
<td>If your Service Provider has more than one URL set for the AssertionConsumerURL, you can set the index to use for eSignature, starting with index 1 or more.</td>
</tr>
<tr>
<td>AuthnRequest URL for eSignature Authentication</td>
<td>You can enter the URL that points to the SAML 2.0 IdP AuthnRequest URL for eSignature authentication. If the URL is the same as the Assertion Consumer URL, you can leave this setting blank.</td>
</tr>
<tr>
<td>Authentication Pop-up Dialog Width</td>
<td>When a user approves a request using eSignature, a dialog opens and a user can enter credentials. This setting controls the width of that dialog box. The default is 500.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Authentication Pop-up Dialog Height</td>
<td>When a user approves a request using eSignature, a dialog opens and a user can enter credentials. This setting controls the height of that dialog box. The default is 300.</td>
</tr>
</tbody>
</table>

5. Click the **Generate Metadata** button underneath the tabs to regenerate the service provider metadata. Copy this data and update it on the SAML IdP.

**Set up e-signature approvals**

The setup required depends on where user credentials are stored.

See the section that matches the source of your user credentials:

- Setting up approvals from a local database
- E-signature SAML properties

**Note:** ADFS 2.0 does not support re-authentication requests that E-Signature requires.

**Approval status**

The approval status of a change request is determined by looking at the current status of all the approvers.

If any approver has rejected the change, the approval status will be Rejected. If all approvers have approved the change, the approval status will be Approved. If all approvers are in the Not Requested status or if there are no approvers, the change status will be Not Requested, otherwise the status will be Requested.

For added flexibility when creating approvals, including the ability to set up an "one of" approval where only one person of a group of approvers needs to approve, consider using **Workflows**.
Generate an approval using approval rules

The system can automatically generate an approval request to individuals or groups when specific criteria are met. The automatic generation of approval requests is driven using the System Policy feature.

In the sample below, a change opened in the category network is assigned to the System Administrator:

Approval Rules

When an approver is automatically added based on approval rules, the status of the approval automatically defaults to "Requested".

Generate approvals using the approvers related list

It is possible to manually add approvers to a request.

Additional approvers can be added by clicking the Edit button in the Approvers section near the bottom of a request. When an approver is added manually, the status for that approver defaults to Not Yet Requested. When the status of the approver changes to Requested, the approver is sent an email requesting approval action.

Generate approvals using workflows

Workflows are a powerful and flexible method of generating approvals. Use workflows to create group approvals and user approvals.

A variety of variables are available to fine-tune the approval process, including the actions that occur when approval or rejection take place. When a workflow activity generates an approval record, the system populates the Workflow activity field on the approval record with a reference to the activity. Do not use this field when creating business logic. For more information, see Approval and Rollback Activities.

Note: Conflicts can arise when the approval process for a table is managed by both the workflow engine and the approval engine. In general, if there is a workflow that manages the approval process for a table, the approval engine should be turned off for that table.

Multiple approvers

With multiple approvers, all approvers must authorize the request before the status will change to "Approved".

Should any approver reject the request, the status will immediately be set to "Rejected".
Receive notifications

Individuals who are designated approvers automatically receive approval notifications, including approval status updates.

Approval notifications will be sent at the following times:

- When an individual is assigned as an approver either automatically or manually. If a group is chosen, then all members of the group will be sent an email. By default, the email an approver receives will contain a "mailto" link that will allow the approver to either approve or reject the request directly from their email system.
- When the request reaches approved status, the person assigned to the request will receive an email indicating it has been approved.

The details contained in the emails and the points at which they are sent can be tailored using System Definition > Business Rules and System Policy.

Note for Blackberry users: In order to see the "mailto" links mentioned above to approve or reject a request (i.e. 'Click here to approve CHG55555' or 'Click here to reject CHG55555'), your Blackberry device must be using version 4.5 of their software which supports HTML emails. If your Blackberry device is using an earlier version, you will not be able to view or use the "mailto" links. However, as a workaround, users can reply to the email and add the statements `state:approved` or `state:rejected` within the body of the email before sending it to force the automatic approval/rejection functionality.

If you create an appropriate Inbound Email Action, you can let approvers respond to approval email notifications with a simple "yes" or "no" answer.

Embed an approval request within the Outlook email client

Embed an interactive approval request for service catalog requests in the email notification sent to a user. The user can accept or reject the approval request from the email client.

Role required: admin

The Outlook Actionable Messages plugin (com.sn_ms_oam) should be activated.

**Note:**

- The Outlook Actionable Messages (OAM) feature is not supported in all Microsoft mail products and versions. To verify whether your version of Outlook supports OAM, refer to the Microsoft documentation.

- Actionable messages are supported only for emails sent from the @service-now.com email address. If you are sending an email from a customized email address, you should register as a new service in the Microsoft website setting the scope as Organization. Specify the provider ID value in the `sn_ms_oam.outlookactionable.originator` property.

- Actionable messages are based on the Sender Policy Framework (SPF)/DomainKeys Identified Mail (DKIM) validation for the email sender verification. If an email recipient receives email via an external provider, emails may not be rendered as adaptive cards.

- You cannot customize the default actionable message templates.

1. Navigate to System Notification > Email > Notifications.
2. For the approval notification that requires user approval, in the **What it will contain** tab, add the following script in the **Message** field in addition to the existing information, or to the **Message** field in the configured email template if applicable.

   ```
   ${mail_script:include_approval_actionable}
   ```

   For example, for the Catalog Approval Request and Approval Request notifications, you can include the script in `request.itil.approve.role` and `change.itil.approve.role` email templates.

   This script includes the Outlook actionable message in the email notification sent to the user for approvals.

3. Click **Update**.

**Dynamic approval forms**

When you are looking at an approval request, the form has a context-appropriate summary of the item to be approved.

For example, if you're looking at a Change Management approval request, you'll see details from the relevant change request. For a Service Catalog approval request, you'll get details of the request.

---

**Rollback Oracle Version**

Performance of the Siebel SFA software has been severely degraded since the upgrade performed this weekend. We moved to an unsupported Oracle DB version. Need to rollback the Oracle instance to a supported version.

---

**Change request approval example**
Scripts and engines execution order

Scripts, assignment rules, business rules, workflows, escalations, and engines all take effect in relation to a database operation, such as insert or update. In many cases, the order of these events is important.

**Note:** Client-based code that executes in the browser, using Ajax or running as JavaScript, will always execute before the form submission to the server.

The order of execution is as follows:

1. **Before** business rules: Scripts configured to execute before the database operation with an order less than 1000.
2. **Before** engines. The following are not executed in any specific order:
   - Approval engine (for task and sys_approval_approver tables)
   - Assignment rules engine (for task tables)
   - Data policy engine
   - Escalation engine
   - Field normalization engine
   - Role engine - keeps role changes in sync with sys_user_has_role table (for sys_user, sys_user_group, sys_user_grmember, and sys_user_role tables)
   - Execution plan engine (for task tables)
   - Update version engine - creates version entry when sys_update_xml entry is written (for sys_update_xml table)
   - Workflow engine (for default workflows)
3. **Before** business rules: Scripts configured to execute before the database operation with an order greater than or equal to 1000.
4. The database operation (insert, update, delete).

5. *After* business rules: Scripts configured to execute after the database operation with an order less than 1000.

6. *After* engines. The following are not executed in any specific order:
   - Label engine
   - Listener engine
   - Table notifications engine
   - Role engine - keeps role changes in sync with sys_user_has_role table (for sys_user, sys_user_group, sys_user_grmember and sys_user_role tables)
   - Text indexing engine
   - Update sync engine
   - Data lookup engine inserts or updates
   - Workflow engine (for deferred workflows)
   - Trigger engine (for all Flow Designer flows)

7. Email notifications. The following are executed based on the weight of the notification record:
   - Notifications sent on an insert, update, or delete
   - Event-based notifications

8. *After* business rules. Scripts configured to execute after the database operation with an order greater than or equal to 1000.

**Fulfiller experience in ServiceNow Agent**

Approve catalog requests, requested items, or change requests from anywhere using the ITSM ServiceNow Agent application.

As an ITSM agent or technician, you can use the mobile app when connected online to accomplish the following:

- Accept or reject the pending approval requests.
- View the completed approval requests.

The request experience is not available in this mobile app.

Watch this three-minute video to learn how to manage approval requests in the mobile app.

**Activation information**

This mobile application runs on the ServiceNow® mobile platform. You should activate the ITSM Mobile Experience (com.sn_itsm_mobile) plugin that enables the ITSM mobile application.

**Get started with the mobile app for Approvals**

Access the My Approvals application instance on your mobile app to manage approval requests using your mobile device.

Role required: business_stakeholder or approver_user
Download the ServiceNow® mobile application on an iOS platform from the Apple App Store or on an Android platform from the Google Play Store.

1. Open the mobile app and tap the plus icon

2. Add a ServiceNow instance. For more information on adding the instance, refer to Add a ServiceNow instance.

3. Tap My Approvals to start managing your requests.

Manage a catalog request approval

Manage your assigned catalog request or requested item by approving or rejecting it from anywhere using your mobile device.

Role required: business_stakeholder or approver_user

1. Tap My Approvals on your mobile app.

2. To approve or reject a pending approval request, perform the following steps.
   a) Tap the Pending Approvals applet.
      All approvals in the Requested state are displayed.
   b) Swipe a request and tap Approve or Reject.

      **Note:** You should specify the reason while rejecting a request.

   c) Optional: To view the details of a pending approval request, tap it.

      **Note:** To approve or reject a request, tap the menu icon

      and tap Approve or Reject.

3. To view a completed approval request, perform the following steps.
   a) Tap the Completed Approvals applet.
      All approval requests that are either accepted or rejected are displayed.
   b) To view the details of the request, tap it.

State flows

State flows enable an administrator to customize transitions from one state to another in tables derived from the Task [task] table and configure the system to perform work during transitions to specific states.

An example of a state transition is when the **State** field in an incident changes from **Active** to **Awaiting User Info**. An administrator might want to trigger an event during this transition or make a specific field mandatory when the incident reaches the end state.

State transitions in the Field Service Management application were reimplemented to use state flows. For information about customizing Field Service Management state flows, see State Flow Customization.
**Installed with state flows**

Several types of components are installed with state flows.

**Tables installed with state flows**

Tables are added with state flows.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State Flow [sf_state_flow]</td>
<td>Contains state flow definitions. This table contains all state flow definitions, including those for work orders and work order tasks.</td>
</tr>
<tr>
<td>Work Order Flow [sf_work_order]</td>
<td>Contains state flow definitions for work orders. This table is installed when Field Service Management is activated.</td>
</tr>
<tr>
<td>Work Task Flow [sf_work_task]</td>
<td>Contains state flow definitions for work order tasks. This table is installed when Field Service Management is activated.</td>
</tr>
</tbody>
</table>

**Business rules installed with state flows**

Business rules are added with state flows.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assert Field Uniqueness in State Flow</td>
<td>State Flow [sf_state_flow]</td>
<td>Ensures that business rules and UI actions are not accidentally copied to new state flows.</td>
</tr>
<tr>
<td>Check Client Script</td>
<td>State Flow [sf_state_flow]</td>
<td>Adds a client script to new records.</td>
</tr>
<tr>
<td>Check Event Rule</td>
<td>State Flow [sf_state_flow]</td>
<td>Adds or deletes event rules, as the event field is updated.</td>
</tr>
<tr>
<td>Check Work Notes Rule</td>
<td>State Flow [sf_state_flow]</td>
<td>Adds or deletes work note rules, as the work notes for a state flow are updated.</td>
</tr>
<tr>
<td>Create Business Rule</td>
<td>State Flow [sf_state_flow]</td>
<td>Automatically creates a business rule when automatic conditions or script are present.</td>
</tr>
<tr>
<td>Create script for Field controls</td>
<td>State Flow [sf_state_flow]</td>
<td>Create scripts for field controls, when they are in use.</td>
</tr>
<tr>
<td>Create UI Action</td>
<td>State Flow [sf_state_flow]</td>
<td>Automatically creates a UI action when manual conditions or script are filled in.</td>
</tr>
<tr>
<td>Delete Related Elements</td>
<td>State Flow [sf_state_flow]</td>
<td>When state flows are deleted, delete all related client scripts, business rules, UI actions and overrides.</td>
</tr>
</tbody>
</table>
### Business rule

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove script for Field controls</td>
<td>State Flow</td>
<td>If all field controls are disabled, see if any of the client scripts should be removed.</td>
</tr>
<tr>
<td>State Change</td>
<td>State Flow</td>
<td>Get the correct state choice value when the state is changed.</td>
</tr>
<tr>
<td>Update dependent records</td>
<td>State Flow</td>
<td>When a state flow is made active or inactive, ensure the business rule and UI actions are made active or inactive as well.</td>
</tr>
</tbody>
</table>

### Script includes installed with state flows

Script includes are added with state flows.

#### Script includes for state flows

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>StateFlow</td>
<td>Implements state flows and supports creation of state flow elements, such as business rules, UI actions, dictionary overrides, and client scripts.</td>
</tr>
<tr>
<td>StateFlowAJAX</td>
<td>Allows access to state flow functionality from client scripts.</td>
</tr>
</tbody>
</table>

### Use state flows

You can create custom state flows for any table that uses states.

Make state transitions occur in any order or skip specific states according to your business practices. State flows can manage the behavior of fields and field visibility on a task form. State flows can also trigger system events that perform work such as sending email notifications.

Administrators can configure state flows to:

- Limit the choice list for the State field to contain only those states that are valid for the flow.
- Define the behavior and visibility of specific fields on a task form when state transitions occur and for certain end states.
- Configure events that are triggered when a task changes states.
- Set up UI actions and business rules to implement certain state transitions, or while the task is in certain states.

The State Flow plugin installs records used by work management to control state transitions for work orders and work order tasks. For detailed information about using work management state flows, see State flow customization.

Creating and customizing state flows requires scripting knowledge. Users with the admin role can create state flow records.

### Dictionary overrides for state flows

A dictionary override in a state flow defines the starting state for all new records in a specific table.
You set an override in tables that extend a base table only, so that your customizations are applied only to the extended table.

1. In a state flow record, select an **Ending state**.
   This is the override value which becomes the starting state for all new records in the table named.

2. Click **Create Default Value**.
   The system populates the **Dictionary override** field with a value of **state**, which is the field in the task table affected by the override. The **Dictionary override** field is read-only. After the override is created, the system hides the **Create Default Value** button on all subsequent state flow forms for that table.

**Events triggered on state changes**

You can configure a state flow to trigger a registered system event when a task transitions from a starting state to a specified end state.

For example, you can use events to trigger email notifications and create script actions. When you attach an event to a state flow, the system creates a business rule called State Flow Events for <table name> for the table specified in the state flow. If you specify a start and end state, the business rule executes when the record transitions from the start state to the end state. If the state flow only specifies an end state, the business rule executes whenever that end state is reached. The system creates one business rule for all state flows containing events on a single table. When all events or all state flows on a table are deleted, the system deletes the business rule.

**Field controls**

You can define controls for individual fields that are enforced when a record transitions between states.

Settings in the Field Controls section of the State Flow form enable you to apply field controls when the system detects a specified state transition or when the end state is the current state when the form is opened. The control is applied only to existing fields on the form. State flows cannot add fields to the form.

For example, you might want the **Problem** field to be visible when an incident moves to the **Awaiting Problem** state. If the incident state changes to **Awaiting User Info**, you hide the **Problem** field and make the **Caller** field mandatory.

When creating field controls, configure state flow records with an ending state only and to create the correct behavior for every ending state you want to control. This configuration ensures that the field controls are set properly when the user selects a new state, and also when the user returns a record’s **State** field to the original state. Only specify a full state transition, with both a starting and ending state, when you want a particular behavior for that precise state transition.

**Note:** State flows use client scripts to enforce field controls. It is possible that your settings can be changed by existing UI policies, which execute after client scripts.

The system creates the following objects, as needed, to enforce field properties in state flows:

**Field Controls**

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business rule</td>
<td>State Flow Notes for &lt;table name&gt;</td>
<td>Enforces mandatory fields for the table on which that field behavior is defined.</td>
</tr>
</tbody>
</table>
Rebuild state flows

You can rebuild state flows when a mismatch between existing and new sys_ids occurs.

When you use an XML file to import a state flow record into an instance, the system attempts to match the incoming states with existing states by comparing sys_ids. Because the sys_ids of items in a choice list can vary between instances, the system can fail to match the states, even though they are otherwise identical.

When matching fails, the start and end states of affected records are left blank or contain numeric values. To repair these records navigate to State Flows > Admin > Rebuild State Flows. This module runs a script that compares the numerical value of each item in the State field choice list until it finds a match in the imported state flow record.

State flow cleanup

Work notes

Create a state flow

Creating State Flows.

2. Fill in the fields, as appropriate.

   The system enforces the field controls with the same client script that filters the choice list for the State field.

Creating state flows

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated record number</td>
</tr>
<tr>
<td>Table</td>
<td>[Required] Table on which the state flow record runs. Only tables that extend the Task [task] table are available in the list.</td>
</tr>
<tr>
<td>Starting state</td>
<td>Name of the state at the beginning of the transition. The selections in this field are filtered by the possible states for the table selected.</td>
</tr>
<tr>
<td>Ending state</td>
<td>Name of the state at the end of the transition. The selections in this field are filtered by the possible states for the table selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client script</td>
<td>Client script to run for this transition. The client script controls the available states you can select by limiting the contents of the State choice list to valid states. This client script also controls specific field behavior configured for state changes in the Field Controls section of the form.</td>
</tr>
<tr>
<td>Event</td>
<td>Name of an existing event to trigger when this transition occurs. See events triggered on state changes for more information.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of this record. Make sure the name is descriptive of the state transition or the processing that the record is performing. This name does not have to be unique.</td>
</tr>
<tr>
<td>Roles</td>
<td>Not used for any processing.</td>
</tr>
<tr>
<td>Active</td>
<td>Enables or disables this state flow record.</td>
</tr>
<tr>
<td>Class</td>
<td>Defines the state flow class for this record. The system selects the appropriate class from these options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>State Flow</strong>: Records created for state flows in all task-based tables except those in work management.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Work Order Flow</strong>: Records created for state flows in the Work Order [wm_order] table. This class is available when work management is activated.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Work Task Flow</strong>: Records created for state flows in the Work Order Task [wm_task] table. This class is available when work management is activated.</td>
</tr>
<tr>
<td>Dictionary override</td>
<td>Sets the starting value for the State field on all new records for the table named in the state flow record. See dictionary overrides for configuration procedures.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Noteworthy comments about this state flow transition. For details about how these notes are used, see Work Notes.</td>
</tr>
<tr>
<td>Comment</td>
<td>Details about the customized record.</td>
</tr>
<tr>
<td>Manual (Runs scripts from a UI action that require the user to click a button or related link.)</td>
<td></td>
</tr>
<tr>
<td>Manual condition string</td>
<td>Conditions for enabling a UI action that cannot be defined with the condition builder. For example, you can use this string to define UI actions for mobile devices. This condition has an [and] relationship with the condition in the Manual condition field.</td>
</tr>
<tr>
<td>Manual condition</td>
<td>Conditions for enabling a UI action that can be defined for fields in the target table. This condition has an [and] relationship with the condition in the Manual condition string field.</td>
</tr>
<tr>
<td>Manual script</td>
<td>Script that defines what the UI action does when the conditions are true. This script runs when the user clicks a button or a related link.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>UI action</td>
<td>[Read Only] Name of the button that the system creates to enable this transition. The system creates the label using the same name as the state flow record that created it.</td>
</tr>
<tr>
<td>Automatic (Runs a business rule automatically when a task record is changed and updated.)</td>
<td></td>
</tr>
<tr>
<td>Automatic condition string</td>
<td>Conditions for running the business rule that cannot be defined with the condition builder, such as evaluating if the proposed transition is a valid flow. This condition has an [and] relationship with the condition in the Automatic condition field.</td>
</tr>
<tr>
<td>Automatic condition</td>
<td>Conditions for running the business rule that can be defined for fields in the target table. This condition has an [and] relationship with the condition in the Automatic condition string field.</td>
</tr>
<tr>
<td>Automatic script</td>
<td>Script that performs additional work when the condition is true. This script can do tasks such as update the date and time the transition occurred or notify someone using email when a specific state change occurs. Automatic state transitions occur when changes are made to the task record.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Name of the business rule created for this transition. Two conditions must be satisfied before this business rule can run. The task must be on a specific starting state, and the Automatic condition must be true. If both of these conditions are satisfied, the business rule performs the transition requested, using the starting and ending states from the State Flow form.</td>
</tr>
<tr>
<td>Field Controls (Determines field properties when a record transitions between states or reaches a specific end state.)</td>
<td></td>
</tr>
<tr>
<td>Mandatory fields</td>
<td>Makes the selected fields required when this transition occurs, or when the end state is the current state.</td>
</tr>
<tr>
<td>Read only fields</td>
<td>Prevents the selected fields from being edited when this transition occurs, or when the end state is the current state.</td>
</tr>
<tr>
<td>Visible fields</td>
<td>Displays the selected fields when this transition occurs, or when the end state is the current state.</td>
</tr>
<tr>
<td>Not mandatory</td>
<td>Makes the selected fields optional when this transition occurs, or when the end state is the current state.</td>
</tr>
<tr>
<td>Not read only</td>
<td>Makes the selected fields editable when this transition occurs, or when the end state is the current state.</td>
</tr>
<tr>
<td>Not visible</td>
<td>Hides the selected fields when this transition occurs, or when the end state is the current state.</td>
</tr>
</tbody>
</table>
3. Determine if you want the state transition method to be manual or automatic and open the appropriate section on the form.

- **Manual**: Click **Create UI Action** to create a button on the task form that enables users to execute the transition manually. The system uses the value in the **Name** field as the label for the UI action. The UI action executes the script in the **Manual Script** field when the conditions are true. For example, a manual transition can create an **Activate** button when an incident is in the **New** state that enables a user to mark the incident as active.

- **Automatic**: Click **Create Business Rule** to create the business rule. The business rule executes the script in the **Automatic Script** field when the conditions are true. For example, a business rule created by the system can set an incident state to **Assigned** when the **Assigned to** field is populated. Business rules are automatically deleted when the state flow record is deleted. For more information, see Business Rules.

4. Optional: Click **Create Client Script** to create the script that limits the values offered in a task record's **State** field to valid states for that transition.

5. Configure the fields in the **Field Controls** section to control how specific fields display when a task record changes states.

**State flow cleanup**

The business rules, client scripts, and UI actions that the system creates automatically to perform custom transitions exist only while the state flow records that use them are present. When all the state flows on a table are deleted, the system attempts to delete any unnecessary programming elements that were created on that table, using these criteria:

<table>
<thead>
<tr>
<th>State Flow Cleanup</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Element</strong></td>
</tr>
<tr>
<td>UI action</td>
</tr>
<tr>
<td>Business rule</td>
</tr>
<tr>
<td>Dictionary override</td>
</tr>
<tr>
<td>Business rule that processes events triggered by a state flow</td>
</tr>
<tr>
<td>Client script (onLoad)</td>
</tr>
<tr>
<td>Client script (onChange)</td>
</tr>
</tbody>
</table>

**Work notes**

Work notes are an important part of the state flow process and are used to communicate information about state transitions.

The state flow adds these work notes to the **Work notes** field of any task making this transition.

These rules apply to state flow work notes:

- For a state flow with no **Starting** state, the work note is added every time the task transitions to the **Ending** state.

- For a state flow with a **Starting** state and an **Ending** state, the work note is added only when the task transitions from that starting state to that ending state.
• If two state flows with work notes have the same Ending state, but only one has a Starting state, the system adds the work notes from the state flow with the starting state. This better matches the state flow work note to the more important transition between specific starting and ending states.

Domain separation and State Flows

This is an overview of domain separation and State Flows. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Support: Data only

Domain separation provides complete data isolation for domain-specific users. Domain separation in this application is supported at the Data only level, meaning it supports the data security model of separating visibility of data from one domain to another. To learn more, see Application support for domain separation.

Geolocation

The geolocation feature uses Google Maps to track users, plan efficient routes between locations, and assist in finding accurate travel times for applications that require this information, such as Work Management.

The system locates users from latitude and longitude information provided by their mobile devices or browsers. Tracking the location of certain users can improve business processes such as the completion of work order tasks. For example, in work management geolocation, the system updates an agent's position each time that agent updates a task record. When the system updates an agent's location frequently, agents and dispatchers can use features like auto-routing to create efficient schedules.

Geolocation features can be configured by users with the admin role.

Activate geolocation

An administrator can activate the Geolocation plugin.

Role required: admin

For plugin activation steps, see Activate a plugin.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar. You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Installed with geolocation

Several component types are installed with Geolocation.
Modified by Geolocation

The Geolocation plugin adds a field called Geolocation tracked to the User [sys_user] table. This field allows the system to track individual users by their geographical coordinates.

**Business rules installed with geolocation**

Business rules are added with activation of Geolocation.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GeoLocation Data updated</td>
<td>User</td>
<td>Populates the Latitude and Longitude fields on the Geolocation History [geo_history] table when the Latitude and Longitude fields are updated on the User [sys_user] table.</td>
</tr>
</tbody>
</table>

**Client scripts installed with geolocation**

Client scripts are added with activation of Geolocation.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Geolocation on Task</td>
<td>Task</td>
<td>Populates the Latitude and Longitude fields on a user record with GPS coordinates when that user loads any record on the Task table or a table that extends Task. This occurs only when geolocation tracking is enabled for the user.</td>
</tr>
</tbody>
</table>

**Properties installed with geolocation**

Geolocation provides the following configurable properties in Geolocation > Administration > Geolocation Properties.

The Google Maps plugin provides additional map properties that are used to implement and control specific geolocation features. You must have a private key for Google Maps API for Business to take advantage of the properties listed here.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.geolocation.allow.toll.roads</td>
<td>Allow toll roads to be used. Allows the system to use toll roads when auto-routing or optimizing task routes for agents.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: True/false</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: True</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.geolocation.default.start.time</td>
<td>Default start time for all agents when no schedule is set. This value sets the start time for a day other than the current day, when no scheduled task exists or is continued from the previous day. This property uses a 24 hour clock.</td>
</tr>
</tbody>
</table>
|                                                |   • **Type**: String  
|                                                |   • **Default value**: 08:00                                                                                                                                  |
| glide.geolocation.evening.rush.hours          | Evening rush hour span, formatted as 14:30-16:00. All times are expressed as a range, separated by a dash with no spaces. Times not using this format are ignored. This property must be used with the work.management.morning.rush.hours and work.management.rush.travel.buffer properties and uses a 24 hour clock. |
|                                                |   • **Type**: String  
|                                                |   • **Default**: 0                                                                                                                                         |
| glide.geolocation.history.cleanup             | Number of days to keep history data. ServiceNow keeps agent geolocation history records for the number of days specified by this value.                                                                   |
|                                                |   • **Type**: Integer  
|                                                |   • **Default value**: 30                                                                                                                                  |
| glide.geolocation.morning.rush.hours          | Morning rush hour span, formatted as 06:30-08:00. This property uses a 24 hour clock. All times are expressed as a range, separated by a dash with no spaces. Times not using this format are ignored. This property must be used with the work.management.morning.rush.hours and work.management.rush.travel.buffer properties. |
|                                                |   • **Type**: String  
<p>|                                                |   • <strong>Default</strong>: 0                                                                                                                                         |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.geolocation.proximity               | Minimum distance an agent must move to be considered in a new location (in meters). This setting establishes a geolocation perimeter that prevents ServiceNow from creating unnecessary history records when an agent has multiple tasks in the same vicinity. An example of this might be when an agent has several tasks in one building. The system assumes that all task activity within the specified radius is part of a single record and does not create additional records when the agent moves from task to task around the building.  
  • **Type**: Integer  
  • **Default value**: 500  
  <i>Note: The iOS version of the app updates geolocation only when the mobile device detects a significant location change, which is determined by the your device's operating system. When the operating system updates its location, your app updates with that location change. Distance and time property values are not honored for the iOS version of ServiceNow apps.</i> |
| glide.geolocation.proximity.location       | Maximum distance an agent can be from a specific location and still be placed at that location (in meters). This setting defines the maximum distance that an agent can be from a specified location and still be placed at that location by the system.  
  • **Type**: Integer  
  • **Default value**: 200 |
| glide.geolocation.rush.travel.buffer      | Percentage to add to all rush hour travel times. The system uses this percentage to calculate schedules when auto-routing an agent. Use this property when both morning and evening rush hour times are defined. An example of a valid time buffer percentage is 15.  
  • **Type**: Integer  
  • **Default value**: 0 |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.geolocation.tracking.frequency               | Sets the length of the recurring interval, in seconds, that the system waits between attempts to update a user's geographic coordinates. The system updates geographic coordinates only for users who have geolocation tracking enabled. Minimum amount of time between updating the user's location (in seconds). This setting defines how long the system waits before updating an agent's location, regardless of task activity or travel. This prevents ServiceNow from creating unnecessary history records if an agent in one location views a task multiple times.  
  • **Type**: Integer  
  • **Default value**: 300  
  
  **Note**: The Android version of the app updates geolocation data at 15 minute intervals. The app collects a user's location using the interval set in this property, but that data is still uploaded to your instance every 15 minutes.  
  
  **Note**: The iOS version of the app updates geolocation only when the mobile device detects a significant location change, which is determined by the your device's operating system. When the operating system updates its location, your app updates with that location change. Distance and time property values are not honored for the iOS version of ServiceNow apps. |
| glide.geolocation.travel.buffer                    | Percentage to add to all travel times. An example of a valid percentage value is 15.  
  • **Type**: Integer  
  • **Default value**: 0                                                                                                                                                                                                                                                                                                                                                         |
| glide.geolocation.work.spacing                     | Amount of time (in minutes) to add between the end of a task and the travel start of the next. An example of a valid time value is 10.  
  • **Type**: Integer  
  • **Default value**: 0                                                                                                                                                                                                                                                                                                                                                           |

### Script includes installed with geolocation

Script includes are added with activation of Geolocation.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GeolocationAJAX</td>
<td>Utilities the system uses when making geolocation AJAX calls.</td>
</tr>
<tr>
<td>GeolocationUtils</td>
<td>Core utilities for geolocation functionality.</td>
</tr>
</tbody>
</table>

**Geolocation Google key**

Geolocation functions in the Now Platform® require a Google Maps API for Business license, or a Google Maps Javascript API Key, to enable use of Google Maps.

The auto-routing or auto-dispatch functions in Field Service Management require this license or Javascript API Key to calculate precise travel time estimates. Without these values, precise driving times cannot be calculated, and it uses rough estimates or fixed times instead.

In **System Properties > Google Maps**, enable the Geolocation feature using the appropriate entries from a Google Maps API for Business license, or a Google Maps Javascript API Key. To learn more, see **Set up Google Maps API**

**Geolocation history**

The Geolocation History [geo_history] table contains the history of each tracked user's location over time.

To view geolocation history, navigate to **Geolocation > Geolocation History**. The record list shows time stamped location data for all users configured for geolocation tracking.

The following system properties, located in **Geolocation > Administration > Geolocation Properties**, control the data that appears in this table.

- Minimum distance an agent must move to be considered in a new location (in meters): Perimeter that defines a single location in which multiple tasks are present. This property prevents the system from creating unnecessary history records when multiple tasks are in the same general location.
- Maximum distance an agent can be from a specific location and still be placed at that location (in meters): Distance that a user can be from a specified location and still be placed at that location when the system creates history data.
- Number of days to keep history data: Time period for which the system retains history data.
- Minimum amount of time between updating the user's location (in seconds): Time period the system waits before updating a user's location, regardless of how often the user accesses tasks.

**Location tracking**

Geolocation adds the **Geolocation tracked** field to the User form. In the default view of a user record, select the **Geolocation tracked** check box to enable location tracking for the user.

When a user has geolocation tracking enabled, the system updates the user's geographic coordinates whenever the user opens, or loads, a record from the Task [task] table or from a table that extends Task. After this initial update, the system continues to update the user's geographic coordinates at a recurring interval if the user does not close or reload the record. To edit the length of this interval, navigate to **Geolocation > Administration > Geolocation Properties** and change the setting for the **property** that regulates the update interval for the user's location. The default setting for this property is 300 seconds (5 minutes).

**Note:** The system can update geographic coordinates only for users who have location services enabled in their browsers. Even users who have the **Geolocation tracked** check box selected may be prompted by their browsers to share or withhold their location.
Survey Management

With the ServiceNow® Survey Management application you can create, send, and collect responses for basic surveys. If installed, you can also use the Survey widget to set up a survey within Service Portal.

Explore
- Upgrade to New York
- Get started with Survey Management
- Key survey terms
- Domain separation for Survey Management

Set up
- Survey Management roles

Administer
- Survey designer
- Survey users and groups
- Customize the appearance of a survey
- Survey definitions
- Survey trigger conditions

Use
- View the results for a survey
- View results for all surveys
- Metric result fields
- View a survey scorecard
- Survey questionnaires

Develop
- Developer training
- Developer documentation

Migrate
- Legacy survey migration

Troubleshoot and get help
- Ask or answer questions in the IT Service Management forum
- Search the HI Knowledge Base for known error articles
- Contact ServiceNow Technical Support

Get started with Survey Management

Two versions of the application are supported, Survey Management, which is the latest version, and Legacy Surveys. Survey Management improves the user interface and extends the capabilities of the Legacy Surveys application.

Configuring surveys

There are many options for advanced configuration in Survey Management:
- Create a survey, add questions, and choose recipients, all in one interface.
- Create conditional questions, which appear only when users answer other questions a certain way.
- Restrict a survey so only specific survey users can take it, and send invitations to those users simultaneously. Alternatively, make the survey a public survey so that any user can take the survey, even anonymous users (users who have not logged in to the ServiceNow system).

Tip: The assessment_take2 UI page should be public for public surveys. If that page is not public, anonymous users do not have access to the page and public surveys do not work.

- Set a schedule to automatically assign a survey to users and to limit how often the same user can take a survey.
- Customize the look and feel of survey questionnaires.
- Save anonymous survey responses.
• Convert survey responses to numerical scores and view them on scorecards.
• Deactivate a survey for maintenance or to retire it without deleting it.

**Note:** Because surveys use the same tables and other back-end components as assessments, you may see assessment elements such as table and field names in certain places throughout the survey feature.

**Legacy Surveys**

Survey administrators can continue to use legacy survey functionality and data, however, it is recommended that you migrate legacy surveys to the Survey Management application. Concurrent use of both survey applications can cause confusion and redundancy.

Survey wizards are not impacted and cannot be migrated.

**Note:** The Legacy Surveys application is not described in the documentation that you are viewing. It is documented on the ServiceNow wiki.

### Version comparison

<table>
<thead>
<tr>
<th>Capability</th>
<th>Surveys</th>
<th>Legacy Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surveys in Service Portal.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save new survey responses each time a user takes the same survey.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Create question templates to reuse sets of answer options.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Categorize survey questions and report on category results.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Deactivate a survey without deleting it.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Create conditional questions.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Send surveys automatically based on a schedule.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Customize survey questionnaire color scheme.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Save anonymous survey responses for logged-in users.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>View survey responses on graphical scorecards.</td>
<td>✔️</td>
<td></td>
</tr>
</tbody>
</table>
### Capability

<table>
<thead>
<tr>
<th>Capability</th>
<th>Surveys</th>
<th>Legacy Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save surveys in a draft state until they are ready to publish.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Create and send surveys from one page.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Allow only specific users to access a survey.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Send surveys based on conditions.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Send survey email notifications.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Limit how often a user can take the same survey.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Add introduction and end note text.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Create survey modules.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Public survey: Allow persons to take a survey without logging in.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Use update sets to track changes.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

### Survey Management roles

The Survey Management application uses the following roles.

No role is required to take assigned survey questionnaires.

#### Survey Management roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey administrator</td>
<td>Create and administer surveys. Survey administrators know what types of</td>
<td>• survey_reader</td>
</tr>
<tr>
<td>[survey_admin]</td>
<td>surveys are necessary, when to send a survey, and to whom. Survey</td>
<td>• assessment_admin</td>
</tr>
<tr>
<td></td>
<td>administrators can use all modules in the Survey application menu.</td>
<td></td>
</tr>
<tr>
<td>Survey reader</td>
<td>View surveys and related information, such as survey responses, survey</td>
<td>none</td>
</tr>
<tr>
<td>survey_reader</td>
<td>groups, scorecards, and reports.</td>
<td></td>
</tr>
</tbody>
</table>
Key survey terms

These survey terms are used throughout the documentation to describe survey management functions and capabilities.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey definition</td>
<td>Root record on which a survey is built. A survey definition contains information such as the survey name, state, and distribution schedule. Each survey definition has its own categories and questions. Survey definitions are comparable to legacy survey masters.</td>
</tr>
<tr>
<td>Public survey</td>
<td>Any user can take a public survey, even users who have not logged in to the ServiceNow system. For a completed survey, the Assigned to field value is Guest.</td>
</tr>
<tr>
<td>Survey category</td>
<td>Represents a theme for survey questions. Categories contain one or more questions. The system creates one category per survey by default. Additional categories are optional.</td>
</tr>
<tr>
<td>Survey question</td>
<td>A question that appears on a survey questionnaire for the associated survey definition. Survey questions are comparable to legacy survey questions.</td>
</tr>
<tr>
<td>Survey user</td>
<td>User who is authorized to receive invitations for a restricted survey.</td>
</tr>
<tr>
<td>Survey instance</td>
<td>Represents one survey questionnaire assigned to one user. Survey instances are comparable to legacy survey instances.</td>
</tr>
<tr>
<td>Trigger condition</td>
<td>Defines a rule that enables the system to send a survey when an action occurs on a table, such as when an incident closes. Trigger conditions are comparable to legacy survey conditions.</td>
</tr>
<tr>
<td>Scorecard</td>
<td>Visual representation of survey responses. Scorecards display a variety of data summaries for one survey definition.</td>
</tr>
</tbody>
</table>

Survey questionnaires

All surveys that are assigned to you appear in your personal assessment and survey queue.

No special role is required to complete a survey but you must be logged in and the survey must be assigned to you. When you submit a survey, the system stores your responses.
Survey notification

If the system is configured to send email, it sends you a notification when a survey is assigned to you. The message contains a link to the survey and instructions for viewing the assessment and survey queue.

Take a survey
Surveys that are assigned to you, and that are not complete, appear in your assessment and survey queue.

Role required: none

Each assessment or survey appears as a card in the queue. The card contains helpful information, including the survey name, state, and due date, and a button to launch the questionnaire. Overdue surveys are clearly marked with a red icon and red due date. You must answer every mandatory question, indicated by a red asterisk, before you can submit the survey. If you start to take a survey but cannot complete it, save your responses and return to it later. When you have answered all the questions and are satisfied with the responses, submit the survey.

1. Navigate to Self-Service > My Assessments & Surveys.
   Users with the assessment_admin role, including survey administrators, can display other users’ assessments and surveys in addition to their own. Use the Show all and Show assigned to me related links at the bottom of the queue to show and hide assessments and surveys. Click a card assigned to another user to open the associated metric type or survey definition.

2. Click Take Survey on a survey card to open the questionnaire.
   If there is more than one survey category, you can click the collapse or expand icon to hide or show the questions in the category.

3. Answer each question to the best of your ability.
   If you are unsure of how to respond to a question or if a question does not apply to a particular record, select Not Applicable, if available.

4. Complete one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save your responses without submitting them</td>
<td>Click Save. You can close the questionnaire and access it later from your queue.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The system does not save the survey if there are invalid responses, such as a letter in a date field. You must enter valid responses or remove invalid responses before you can save the survey.</td>
</tr>
<tr>
<td>Submit the survey after answering all questions</td>
<td>Click Submit. You cannot return to the questionnaire after submitting.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If there is an unanswered mandatory question or an invalid response, an error message appears and the problematic questions are temporarily highlighted.</td>
</tr>
</tbody>
</table>

Domain separation for Survey Management

This is an overview of domain separation as it pertains to Survey Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.
Overview

Support: Data onlyDomain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

As a survey creator, survey_admin can create surveys in the assigned domain. A Global domain survey_admin can create or edit survey in any domain.

As a survey taker, a user can access the survey record and take the survey based on the domain of the survey record and user. Global domain users can take a survey in any domain.

How domain separation works in Survey Management

There are several main areas to consider in how domain separation works in Survey Management.

Survey Management in domain-separated instances

The following domains are available by default after activating the Domain Support-Domain Extensions Installer [com.glide.domain.msp_extensions.installer] plugin. Only ServiceNow employees can activate this plugin.

- Global
- Acme
- Cisco

Access to surveys in domain-separated instances

Based on the domain of the survey record and users, users can access the survey record and take the survey.

Global domain users can access survey records in any domain. Users in any other domain can access records in their domain and Global domain. For example, users in the Acme domain can access records in the Acme domain and the Global domain.

Global domain users can take a survey in any domain. Users in any other domain can take surveys in their domain as well as the Global domain. For example, users in Acme domain can take surveys in the Acme domain and the Global domain.

<table>
<thead>
<tr>
<th>Location of the survey record</th>
<th>Users who can access and take the survey</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Global, Acme, Cisco</td>
</tr>
<tr>
<td>Global</td>
<td>Yes, Yes, Yes</td>
</tr>
<tr>
<td>Acme</td>
<td>Yes, Yes, No</td>
</tr>
<tr>
<td>Cisco</td>
<td>Yes, Yes, Yes</td>
</tr>
</tbody>
</table>

Any domain user can assign a survey in that domain to the same domain user or a Global domain user. For example, an Acme domain user can assign a survey to a Global domain user or an Acme domain user. Users from other domains are not visible to the Acme domain user.

Although the Global domain user can view a survey from other domains, this user cannot assign the survey of one domain to a user from a different domain. For example, a Global domain user can assign a survey from the Acme domain to another Global domain user or an Acme domain user, but not to a Cisco domain user.
**Note:** When a task is closed in a child domain and the assigned survey is either in the child domain or the global domain, the user from the child domain can then take the survey.

**Trigger conditions in domain-separated instances**

A Global domain user can create a triggered condition for a survey from any domain. The Global domain user can create an incident and trigger the survey by selecting a user from the other domain in the **User field** under **Caller**. However, the Global user cannot assign the survey to the user of different domain.

A user can assign a trigger condition to a survey if the user belongs to the Global domain or the Survey domain.

If there is no domain path for a trigger condition, users from any domain can view the trigger condition. For example, in the `asmt_condition` table that has no column for the domain path, users from the Acme domain can view the trigger condition created by the Cisco domain users.

**Survey responses and results**

There is a metric result record for each user response to each question on every survey instance. Survey results for each question and category are calculated automatically based on the metric result records.

If you use survey result calculations for results and scorecards, ensure that the **positive indicator** field for the question is set appropriately, based on the answer options. To have any results, a category must contain scored questions.

**Survey responses**

Survey responses are stored in the Metric Result `[asmt_metric_result]` table and display the recipients' answers to each question in a category. To view general results, navigate to **Survey > Survey Responses**. To view results for a particular criterion, use a filter on the Metric Result `[asmt_metric_result]` table. For example, to view results based on the assignment group, apply a filter condition for assignment group.
Category results

Category results are stored in the Assessment Category Result [asmt_category_result] table and display the overall ratings for each category based on the weighted value for each scored question. To view these results, navigate to Assessments > Results > Category results and filter the results using the [Type.Evaluation method] [is] [Survey] condition.
Assessment category results

Survey scorecards

A scorecard provides a visual breakdown of survey responses, based on the way questions were answered, by category. To access a scorecard, see View a survey scorecard.

View results for all surveys

You can view the survey responses that are stored on the Metric Result [asmt_metric_result] table.

Role required: survey_admin or survey_reader

1. Navigate to Survey > Survey Responses.
   
   Do not confuse this module with Survey > Legacy Surveys > Survey Responses, which displays legacy survey responses.

   The Type column displays the survey definition each response is associated with.
2. Select a response to view its details.

**View the results for a survey**

You can view the responses for one survey definition. Survey results are stored on the Metric Result [asmt_metric_result] table.

Role required: survey_admin or survey_reader

1. Navigate to **Survey > View Surveys**
2. Open a survey definition.
3. Under **Related Links**, click **View Responses**, which is available only if there are results.
   The results are grouped by metric, which is what questions are called in assessments.
4. Open a metric result to view more detail.
   The metric result contains the user's response and calculated values of interest to advanced survey administrators. Because the Metric Result table is also used by the assessment feature, many field names are not clear in the context of surveys.

**Metric result fields**

List of field descriptions for the Metric Result form.
### Metric Result form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment group</td>
<td>Assessment group to which the metric result belongs. An assessment group is a container for survey instances and results generated in a single occurrence. The system generates an assessment group every time at least one survey instance is created. If multiple survey instances are created at once, such as when a survey administrator sends invitations to a list of survey users, they are all stored in the same assessment group.</td>
</tr>
<tr>
<td>Metric</td>
<td>Question that the user answered.</td>
</tr>
<tr>
<td>Data type</td>
<td>Data type of the question the user answered.</td>
</tr>
<tr>
<td>Method</td>
<td>Assessment method. Always Assessment for surveys.</td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time the metric result was last updated.</td>
</tr>
<tr>
<td>Source</td>
<td>Survey definition from which the associated survey instance was generated.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User who completed the survey questionnaire.</td>
</tr>
<tr>
<td>Instance</td>
<td>Survey instance completed by the Assigned to user.</td>
</tr>
<tr>
<td>Actual value</td>
<td>Value obtained from the user response to the question. The actual value is determined by the question data type:</td>
</tr>
<tr>
<td></td>
<td>• Checkbox: The actual value is 0 if the check box is cleared and 1 if it is selected.</td>
</tr>
<tr>
<td></td>
<td>• Choice or Likert Scale: The actual value is equal to the Value of the metric definition associated with the chosen answer option.</td>
</tr>
<tr>
<td></td>
<td>• Date, Date/Time, or String: The actual value is -1 to indicate that these data types do not contribute to category result calculations.</td>
</tr>
<tr>
<td></td>
<td>• Template: The actual value is equal to the Value of the template definition associated with the chosen answer option.</td>
</tr>
<tr>
<td></td>
<td>• Yes/No: The actual value is 0 if the response is No and 1 if it is Yes.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>Adjusted value that accounts for the Scale definition setting, minimum and maximum values, and other factors.</td>
</tr>
<tr>
<td></td>
<td>The equation that generates the value and an example calculation appear in Normalized value for an assessment.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String value</td>
<td>Value that displays the response as it appears on a questionnaire. In some cases this is the same as the <strong>Actual value</strong>, such as when the question data type is <strong>Percentage</strong>. The string value is <strong>N/A</strong> for unanswered questions of certain data types.</td>
</tr>
</tbody>
</table>

**Normalized value for an assessment**

The normalized value is calculated based on a linear equation and the scale definition of the metric.

**Normalized value for any metric**

The normalized value is directly proportional to the scale definition of the metric. If the scale definition is low, that is, the lower scale values are better, then $\text{Normalized value} = 1.0 - \text{Normalized value}$.

For reporting purpose, use the Metric Result [asmt_metric_result] table.

$\text{Normalized value} = \frac{(\text{Input Value} - \text{Min value defined in metric})}{(\text{Max value defined in metric} - \text{Min value defined in metric})} \times \frac{\text{current metric weight}}{\text{sum of valid metric weight in the metric category}} \times \text{scale_factor}$

**Note:**

- If a metric is skipped when taking the assessment, its weight is excluded when calculating the sum of valid metric weight in the metric category.
- The following metric types are excluded in the normalized value calculation:
  - String
  - Date
  - Date/Time
  - Reference
  - Attachment
  - Ranking

For example, consider the following scenario.

Calculate the normalized value for the **Please rate the competency of the technician** metric.

**Values of the metric**

<table>
<thead>
<tr>
<th>Input value</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum value</td>
<td>1</td>
</tr>
<tr>
<td>Maximum value</td>
<td>6</td>
</tr>
<tr>
<td>Current metric weight</td>
<td>10</td>
</tr>
<tr>
<td>Number of metrics in the metric category</td>
<td>6</td>
</tr>
</tbody>
</table>
  - 4 of type=number
  - 1 of type=yes/no
  - 1 of type=string (invalid data type; value cannot be calculated)
<table>
<thead>
<tr>
<th>Valid metric weight of each response</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale factor</td>
<td>10</td>
</tr>
</tbody>
</table>

Normalized value = \( \frac{3 - 1}{6 - 1} \times \frac{10}{(10 + 10 + 10 + 10 + 10)} \times 10 = 0.8 \)

**View a survey scorecard**

A survey scorecard provides a visual breakdown of survey responses by category, based on the way questions were answered.

Role required: survey_admin or survey_reader

A scorecard displays charts for survey results, in which category and question responses are analyzed and current ratings are compared with previous ratings. Users can examine ratings over time, compare question ratings, or compare the ratings of all categories. All ratings are averages for the time range selected. The system dynamically updates a scorecard each time you view it, so the ratings reflect recently completed surveys.

1. Navigate to **Survey > View Surveys**.
2. Open a survey definition.
3. Under Related Links, click View Scorecard. The interactive scorecard displays the following filters:
   - **Question Results**: Displays the result of all questions or an individual question.
   - **Category Results**: Displays the results of all questions associated with an individual category or all categories.
   - **Average Ratings**: Displays the result of weighted average rating for each survey question in an individual category or all categories.
   - **History**: Displays the result of all questions in comparison with their history (by calendar year or quarters).
   - **Sentiment Analysis Results**: Displays the results of sentiment analysis for the survey.

**Note**: The scorecard link is hidden if there are no survey results to report.

**Survey scorecard category results**

The Category Results view is a stacked bar chart showing survey results for all questions in an individual category or all categories by respondent count.

Select a category from the list to display the questions from that category in the chart.

This view displays responses that use the following data types:

- Checkbox
- Choice
- Likert Scale
- Number
- Template
- Yes/No
- Multiple selection
- Image Scale
- Numeric Scale

**Note**: The **Checkbox** and **Yes/No** data types are combined into the **Boolean** data type in the Survey Designer.
Survey category results

To view details about a specific response, point to the colored bar to display the response, the number of responses, and the percentage it represents of all the responses to that question.

Survey scorecard category results detail
Survey scorecard question results
The Question Results filter displays the result of all questions or an individual question using charts or lists. For the String, Attachment, Date, Date/time, Reference, and Ranking data types, the results are displayed in the list view. The results of all other data types are displayed in the pie chart view.

Pie chart
The pie chart shows question results for all data types other than those that are displayed in the list view. See Survey question data types.

- Checkbox.
- Boolean.
- Choice.
- Likert Scale.
- Number.
- Percentage.
- Yes/No.
- Image Scale.
- Multiple Selection.
- Template. The question result shows the aggregated net promoter score (NPS) with promoters, detractors, and passives.

<table>
<thead>
<tr>
<th>Question score</th>
<th>NPS category</th>
</tr>
</thead>
<tbody>
<tr>
<td>9 or 10</td>
<td>Promoter</td>
</tr>
<tr>
<td>7 or 8</td>
<td>Passive or Neutral</td>
</tr>
<tr>
<td>0 to 6</td>
<td>Detractor</td>
</tr>
</tbody>
</table>

The result is calculated as:

- \( \% \text{Promoters} = \frac{\text{Number of promoters}}{\text{Sample size}} \)
- \( \% \text{Detractors} = \frac{\text{Number of detractors}}{\text{Sample size}} \)
- \( \% \text{Passives} = \frac{\text{Number of passives}}{\text{Sample size}} \)
- \( \text{NPS} = \% \text{Promoters} - \% \text{Detractors} \)

Note: The Checkbox and Yes/No data types are combined into the Boolean data type in the survey designer.
Service Desk Satisfaction Survey

Survey Scorecard

How courteous and respectful was the technician who responded? (1=poor, 6=excellent)

- 2 = 2 (14.29%)
- 3 = 2 (14.29%)
- 4 = 9 (54.29%)
- 5 = 1 (7.14%)

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Survey scorecard average ratings

The Average Ratings view displays the weighted average rating for each survey question in an individual category or all categories.

Use this view to learn how individual questions affect the overall rating for the category. Select a survey category from the choice list to display the chart for that category.
Service Desk Satisfaction Survey

Survey Scorecard

Average question rating in category: Service Desk Satisfaction Survey

- How courteous and...
- How satisfied are...
- How satisfied were...
- Please rate the t...
- Was technician ab...

Average Normalized value
To view the effect of each question’s ratings on the entire category’s ratings, point to the colored bar. The pop-up box shows the percentage of the total ratings represented by each individual question’s weighted average.

![Graph showing Compare Plans and Benefit Satisfaction with Benefit Satisfaction rating of 0.88 (23.75%)]

**Average ratings detail**

**Survey scorecard history**

The History view compares the current ratings for the categories and their questions with ratings from the previous three years or four quarters.

Ratings that have declined are highlighted in red and display negative numbers. Ratings that have improved are highlighted in green with positive numbers. Arrow icons beside the values in the **Diff** column indicate the trend of the current survey against the previous survey.

Point to a category to display a line chart that shows the rating trend for that category. Click a category to view the Survey Category form containing the survey questions.
Survey scorecard trend chart

3 years

To calculate the current ratings, the system averages the ratings from the trailing twelve month (TTM) period. The Diff column shows the discrepancy between the current ratings and the previous calendar year’s ratings.
Service Desk Satisfaction Survey

Survey Scorecard

Overall Rating

Service Desk Satisfaction Survey

<table>
<thead>
<tr>
<th></th>
<th>Current</th>
<th>Diff</th>
<th>2013</th>
<th>2012</th>
<th>2011</th>
</tr>
</thead>
<tbody>
<tr>
<td>How satisfied were you with the response time to your incident? (1=not at all, 6=completely)</td>
<td>5.40</td>
<td>0.00</td>
<td>5.40</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>How courteous and respectful was the technician who responded? (1=poor, 6=excellent)</td>
<td>0.00</td>
<td>-1.02</td>
<td>1.02</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Please rate the technical competency of the technician serving you (1=poor, 6=excellent)</td>
<td>0.00</td>
<td>-1.02</td>
<td>1.02</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Was technician able to resolve your issue during the first call?</td>
<td>0.00</td>
<td>-1.00</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>How satisfied are you with your overall service experience? (1=not at all, 6=completely)</td>
<td>0.00</td>
<td>-1.14</td>
<td>1.14</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Survey scorecard history - 3 years
4 quarters

Quarterly surveys compare the average rating for each question and category in the current quarter against the average ratings from the previous four quarters. The **Diff** column shows the discrepancy between the current ratings and the previous quarter's ratings. The column labels count backward, by quarter from the current quarter. For example, if the current quarter is the **3rd** quarter of 2015, then the previous quarters appear as **2nd** [2015], **1st** [2015], **4th** [2014], and **3rd** [2014]. All four of the previous quarters appear, whether or not there was any data for those quarters.
## Service Desk Satisfaction Survey

### Survey Scorecard

<table>
<thead>
<tr>
<th>Overall Rating</th>
<th>Current</th>
<th>Diff</th>
<th>1st</th>
<th>2nd</th>
<th>3rd</th>
<th>4th</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Desk Satisfaction Survey</td>
<td>0.00</td>
<td>-5.40</td>
<td>5.40</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>How satisfied were you with the response time to your incident? (1=not at all, 6=completely)</td>
<td>0.00</td>
<td>-1.02</td>
<td>1.02</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>How courteous and respectful was the technician who responded? (1=poor, 6=excellent)</td>
<td>0.00</td>
<td>-1.21</td>
<td>1.21</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Please rate the technical competency of the technician serving you (1=poor, 6=excellent)</td>
<td>0.00</td>
<td>-1.02</td>
<td>1.02</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Was technician able to resolve your issue during the first call?</td>
<td>0.00</td>
<td>-1.14</td>
<td>1.14</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

### Survey scorecard history - 4 quarters
**Export a survey scorecard as an image**
You can export a scorecard as an image to use in presentations or other documents.

Role required: admin or survey_admin

1. Click the menu icon ( расположен) and select **Save as PNG** or **Save as JPEG** and wait for the export to complete.

2. Click **Download** and save the scorecard image to a storage location.
Survey administration

Survey administrators—users with the survey_admin role—create and maintain surveys and configure how they are distributed and published. Surveys on Service Portal are also supported.

Survey administration includes the following procedures.

• Create, customize, and publish surveys.
• Write and maintain survey questions.
• Define trigger conditions for when surveys are sent to users, such as when an incident closes.
• Maintain surveys and survey questions as the organization’s needs change.

To set up surveys in Service Portal, you must first install Service Portal and then configure the Survey widget on the page. The base system includes the Survey widget.

Surveys in Service Portal

If Service Portal is installed, you can use the Survey widget to set up surveys, quizzes, assessments, risk assessments, and attestations in Service Portal. Surveys for users on mobile devices are fully supported in Service Portal.

To create an intuitive interface for your users, you can set up surveys in Service Portal. You must first install Service Portal and then configure the survey widget on the page. To learn more about configuring a widget, see configure widget instances.
To configure a Survey widget on a page, CTRL + right-click the widget heading and select **Instance Options**.

**Service Portal: Instance options (properties) for the Survey widget**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max records</td>
<td>Number of surveys to list on the Service Portal homepage. The user can click the <strong>View all</strong> link to view all items. Default: 5</td>
</tr>
<tr>
<td>Title of the widget</td>
<td>Text that appears in the title bar of the surveys widget. Default: <strong>My Surveys</strong></td>
</tr>
</tbody>
</table>
Each survey on the My Surveys page contains a progress bar and a description. The color in the progress bar increases as a survey is completed. In the case of a triggered record, the table title is used for the survey description.

For mobile users, the Pagination setting for Service Portal view survey designer property is set to one question per page by default.
One Click survey

A One Click survey has no introduction page in Service Portal. This survey does not have the Submit and Cancel buttons in the desktop and iPad view.

Note:
- The One Click Survey field should be selected in the survey definition.
- If the public access is enabled for a One Click survey, a user can submit the survey without having to log in.

A kiosk survey is a One Click survey with only one question of any of the following types:
- Image Scale
- Choice
- Likert Scale
- Numeric Scale
- Yes/No

When you click the answer of the kiosk survey question in Service Portal, the survey is submitted and the end note is displayed on the same page as that of the survey questions.

Note:
- A kiosk survey does not have any Submit or Cancel buttons.
- A kiosk survey cannot have a signature, dependent questions, or additional information.

URI parameters for One Click survey

Pass these URI parameters through the createAssessment() API to store their values in the asmt_assessment_instance table for both platform view and Service Portal view.

**URI parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_refresh_interval</td>
<td>Refresh time (in seconds) after the survey submission to create another instance. For example, sysparm_refresh_interval=5.</td>
</tr>
<tr>
<td>sysparm_trigger_table</td>
<td>Location that is stored as the Trigger Table field in the asmt_assessment_instance table. For example, sysparm_trigger_table=incident.</td>
</tr>
<tr>
<td>sysparm_trigger_id</td>
<td>Location sysId that is stored as the Trigger ID field in the asmt_assessment_instance table. For example, sysparm_trigger_id=1c741bd70b2322007518478d83673af3.</td>
</tr>
<tr>
<td>sysparm_kiosk</td>
<td>When set to true, both sysparm_trigger_table and sysparm_trigger_id parameters should be specified. This is a mandatory parameter for kiosk requests. For example, sysparm_kiosk=true.</td>
</tr>
</tbody>
</table>
View the overview of all surveys

Use this homepage to view various survey reports such as results by metric type and state.

Role required: admin or survey_admin

You can refresh, add, delete, and rearrange widgets. All reports on the Survey Overview page have demo data.

1. Navigate to Survey > Overview.

The following reports are available:

<table>
<thead>
<tr>
<th>Report</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment group Customer Satisfaction 90 day average</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Service Desk Survey 'Timely Response' 90 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Surveys by Metric Type and State</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
</tr>
<tr>
<td>Service Desk Survey 'Overall Experience' 60 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Service Desk Survey 'Tech Courteous' 90 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Service Desk Survey 'First Call Resolve' 60 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Service Desk Survey 'Tech Competence' 60 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
</tbody>
</table>

2. To view the required information, click elements within the reports.
3. To refresh, edit, or close a widget, point to the widget and select the required option.

Survey designer

Users with the survey_admin role can use the survey designer. The survey designer lets you create survey categories and questions, configure the details, and publish the survey to specific users or groups.

You can assign a survey to individual users or groups who receive all the questions from all the categories. You can also customize each question and make it dependent on the response to another question. The following describes the procedures you follow to create and publish a survey.

• Create survey categories.
• Create questions within each category.
• Configure survey details, such as introductory and closing remarks and time limit.
• Select recipients for the survey.
• Publish the survey to the selected users or groups.

Note: The survey designer replaces the survey creator in the Legacy Surveys application. If you are using Internet Explorer version 8 or earlier, the system redirects you to the survey creator.

Survey designer elements
The survey designer is accessible from Survey > Survey Designer.

The survey designer contains the Controls tab, the Questions tab, the Categories tab, a header bar, and the design canvas.
Controls tab

To create a question, drag the appropriate data type control from the Controls palette and drop it onto the designer canvas.
<table>
<thead>
<tr>
<th>Controls</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Boolean</td>
</tr>
<tr>
<td>Choice</td>
<td>Date</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Number</td>
</tr>
<tr>
<td>Percentage</td>
<td>Scale</td>
</tr>
<tr>
<td>Numeric Scale</td>
<td>String</td>
</tr>
<tr>
<td>Template</td>
<td>Reference</td>
</tr>
<tr>
<td>Image Scale</td>
<td>Multiple Selection</td>
</tr>
<tr>
<td>Ranking</td>
<td></td>
</tr>
</tbody>
</table>
The assessment engine provides a built-in result calculation feature that converts responses to scored question data types to a score from 0 through 10.

### Question data types

<table>
<thead>
<tr>
<th>Data type</th>
<th>Scored</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>No</td>
<td>Question with a Manage Attachments icon that allows users to attach one or more files.</td>
</tr>
<tr>
<td>Boolean</td>
<td>Yes</td>
<td>Question with a check box or <strong>Yes</strong> and <strong>No</strong> choices for user responses.</td>
</tr>
<tr>
<td>Choice</td>
<td>Yes</td>
<td>List of predefined options. For more information, see the definition of the <strong>Choices</strong> field in Create a question in the survey designer.</td>
</tr>
<tr>
<td>Date</td>
<td>No</td>
<td>Date field.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>No</td>
<td>Date and time field.</td>
</tr>
<tr>
<td>Number</td>
<td>No</td>
<td>Number field with predefined minimum and maximum values. The default is 1-10.</td>
</tr>
<tr>
<td>Percentage</td>
<td>No</td>
<td>Percentage field with a prescribed range.</td>
</tr>
<tr>
<td>Scale</td>
<td>Yes</td>
<td>Predefined Likert scale. Answer options appear as radio buttons.</td>
</tr>
<tr>
<td>Numeric Scale</td>
<td>Yes</td>
<td>Selectable number scale. The default is 1-5. Answer options appear as radio buttons.</td>
</tr>
<tr>
<td>String</td>
<td>No</td>
<td>Single or multi-line text field.</td>
</tr>
<tr>
<td>Template</td>
<td>Yes</td>
<td>Choice list of templates that provide a predefined scale of options. For details, see Quiz scorecards.</td>
</tr>
<tr>
<td>Reference</td>
<td>No</td>
<td>Choice list of fields from a specified reference table. This data type does not support reference qualifiers. For example, a user could select a user name if you specify sys_user as the reference table.</td>
</tr>
<tr>
<td>Image Scale</td>
<td>Yes</td>
<td>Question with a choice of images that can be selected. A template can be used to apply the same images to multiple questions.</td>
</tr>
<tr>
<td>Multiple Selection</td>
<td>Yes</td>
<td>Question with multiple check boxes that can be selected.</td>
</tr>
<tr>
<td>Data type</td>
<td>Scored</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Ranking</td>
<td></td>
<td>Question with an order number to be selected for each option. One order number cannot be selected twice. This question can be mandatory and it can also be dependent on a parent question, but not vice versa.</td>
</tr>
</tbody>
</table>

**Questions tab**

This tab displays all metrics added to the question bank for surveys. Use the **Filter** field to search for questions. Each metric is displayed with its name and type.

**Categories tab**

This tab displays all metric categories added to the question bank for surveys. All metrics in the question bank are group under the corresponding metric category. Use the **Filter** field to search for categories or questions.

**Header bar**

The tabs on the header bar display views and a menu of functions. Click a tab to change the view on the canvas:

- **Design**: Add and configure the properties of categories and questions. This is the default view.
- **Configuration**: Create introductions and end notes for surveys and select a signature.
- **Availability**: Select the recipients for each category in the survey.

Point to the menu icon () to select an option. The list of options depends on the currently open survey.

- **Save**: Save the current survey without changing its state.
- **Preview**: Display a preview of the survey as it appears to recipients.
- **Publish**: Distribute the survey to the selected recipients.
- **Save and Publish**: Save the survey to the **Draft** state and distribute the survey in one step.
- **New Survey**: Open a fresh canvas for a new survey.
- **Load Survey**: View the list of existing surveys.
- **Copy Survey**: Copy the current survey.

**Design canvas**

New surveys open in the canvas of the **Design** view. The survey **Name** field appears above first category in the canvas. A blank question field appears in the category container.
Initial appearance of the Survey Designer canvas

**Configure a survey in the survey designer**
Configuration settings apply to the entire survey.
Role required: admin, survey_creator, or survey_admin

1. Navigate to Survey > View Surveys.
2. Open a survey definition in Survey Designer.
3. Select the **Configuration** tab and complete the Survey Designer Configuration form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select the check box to enable the distribution of this survey to recipients.</td>
</tr>
<tr>
<td>Survey Owners</td>
<td>Owners of the survey. You can add a user with the survey_creator, survey_admin, or assessment_admin role.</td>
</tr>
<tr>
<td>Anonymize responses</td>
<td>Select the check box to collect survey responses anonymously. Recipients are not listed with survey results. When a user submits a survey, the system clears the <strong>Assigned to</strong> field for the associated survey instance. Also, survey responses for anonymous surveys do not contain Assigned to values.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of this configuration or the survey to which it is attached.</td>
</tr>
<tr>
<td>Do not show survey introduction notes</td>
<td>Check box to skip the introduction notes when a survey is launched. This functionality is applicable in both the Now Platform and Service Portal product versions.</td>
</tr>
</tbody>
</table>

**Note:** The **Assigned to** field is cleared. However, each response record includes the **Created By** and **Updated By** fields that are accessible to users with the survey_admin role.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>Introductory content to display on surveys. You can add a welcome message or background information about the survey.</td>
</tr>
<tr>
<td>Signature</td>
<td>Acknowledgement by a survey recipient of requirements, admonitions, or expectations related to a survey.</td>
</tr>
<tr>
<td>Return URL</td>
<td>Destination address of a web page that is presented to users after they submit a completed survey. When a return URL is configured, the end note content does not appear.</td>
</tr>
<tr>
<td>End note</td>
<td>Content that is displayed to recipients after they submit a completed survey. You can add a thank you message, follow-up instructions, or other applicable information. End notes are not displayed if a Return URL is specified.</td>
</tr>
<tr>
<td>Public Survey</td>
<td>Enables public access to the survey. No login is required to take a public survey and users or non-users can respond anonymously. For completed public surveys, the Assigned to field value is Guest.</td>
</tr>
<tr>
<td>Note: This check box is available only after you save the survey.</td>
<td></td>
</tr>
<tr>
<td>Survey Publish URL</td>
<td>Specifies a URL of the survey that can be shared with users.</td>
</tr>
<tr>
<td>Note: This field is available only after you publish the survey.</td>
<td></td>
</tr>
<tr>
<td>Pagination setting for Service Portal view</td>
<td>Specify how the user will see pages on the desktop or tablet view in Service Portal.</td>
</tr>
<tr>
<td>• Category: Display each category on a separate page.</td>
<td></td>
</tr>
<tr>
<td>• Question: Display each question on a separate page. This happens for mobile regardless of this setting.</td>
<td></td>
</tr>
<tr>
<td>• None: All items on a single page—no pagination</td>
<td></td>
</tr>
<tr>
<td>Default: Category</td>
<td></td>
</tr>
<tr>
<td>Note: This field appears only when Service Portal is installed.</td>
<td></td>
</tr>
<tr>
<td>One Click Survey</td>
<td>Enables a One Click survey in Service Portal.</td>
</tr>
<tr>
<td>Note: This option can be selected if the Pagination setting for Service Portal view is set to None.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source Table</td>
<td>Table whose field is used as a dynamic value for a question in a triggered survey.</td>
</tr>
</tbody>
</table>

**Note:** When you select a source table, ensure that its relevant field is selected as Source Field value of a metric.

<table>
<thead>
<tr>
<th>Allow Sentiment Analysis</th>
<th>Enables sentiment analysis for this survey.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Amount of time that recipients are given to complete this survey, starting from the time that the survey is generated. The default duration is 14 days.</td>
</tr>
</tbody>
</table>

**Note:** By default, the system runs the Cancel Expired Assessments script every 30 days to cancel expired survey, assessment, and quiz instances that are in the Work in progress or Ready to take states.

<table>
<thead>
<tr>
<th>Outlook Actionable Message</th>
<th>Includes an embedded survey in the survey email notification. After you select this check box and save the survey, a validation is run to ensure all survey questions are supported.</th>
</tr>
</thead>
</table>

4. Select the **Availability** tab and complete the form,

**Availability tab fields**

<table>
<thead>
<tr>
<th>Accessible by</th>
<th>Defines who can access the survey. Possible values are</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Anyone: Accessible by anyone with the survey link.</td>
</tr>
<tr>
<td></td>
<td>• Specific users: Accessible by specified users.</td>
</tr>
</tbody>
</table>

| Survey groups only           | If selected, a survey is available for survey groups only.                  |

**Note:** This field is displayed only if the Accessible by is Specific users.

| Add group users              | Group users for whom the survey is available.                              |

**Note:** This field is displayed only if the Accessible by is Specific users.

| Add users                    | Users for whom the survey is available.                                   |

**Note:** This field is displayed only if the Accessible by is Specific users.
**Survey categories**
Survey categories provide a way to group questions of a similar theme for a given survey.

There must be at least one survey category per survey definition and every survey question must be associated with a category. When you create a survey, the system generates one category, which all the questions belong to.

For simple surveys, one category is usually enough. Consider creating additional categories if you want to accomplish any of the following tasks.

- Separate groups of questions into collapsible sections by category on the survey questionnaire.
- Report on category scores, which are calculated based on responses for all questions within each category.

**Create a category in the survey designer**
A category represents a theme for evaluating a specific element of the survey topic and contains questions pertaining to that theme.

Role required: admin or survey_admin

When you create a survey, the system creates a default category, using the name of the survey. You can use this category, modify it, and create additional categories as needed. To have any results, a category must contain scored questions.

1. Navigate to **Survey > Survey Designer**.
2. Enter the name of the survey in the **Name** field.
   The system uses this name as the name of the survey and of the first category.
3. To configure the category, click the gear icon in its title bar and complete the following steps in the Properties dialog box.
   a) Enter a new name and a description for the category.
   b) Enter text in the **Details** field that introduces or explains the category to recipients.
   c) Click the **X** icon to close the Properties dialog box and save your settings.

4. To add a new category, click the **+** icon in the title bar of an existing category.
   The new category appears below the category that you selected to create it. You can click the **X** icon in a category header to delete a category that you added in error.

**Create a survey category in a survey**
You can modify an existing survey to add one or more survey categories.

Role required: admin or survey_admin

Only one category is required for each survey, but you can add additional categories as needed.

1. Navigate to **Survey > View Surveys**.
2. Open a survey definition.
3. In the **Metric Categories** related list, open a category or click **New**.
   Each survey category is stored as a record on the Metric Category [asmt_metric_category] table with a modified view for survey use.
4. Enter the survey category name and description.
   The category name appears on questionnaires when either of the following is true:
   - There is more than one category for the survey.
   - There is only one category and its name is different from the survey definition name. If you create a
     survey using the survey creator, the category name is the same as the survey definition name.

5. Right-click the form header and click **Save**.
   The **Assessment Metrics** and **Users** related lists appear.

6. Click **Update**.

   *Create a question in the survey designer*
   You can create multiple questions for each category in the survey designer, but each question can only be
   associated with one category.

   **Role required:** admin or survey_admin

   The data type that you select for each question determines how it can be answered by survey recipients.

   1. In the Design view, drag a data type icon from the Controls palette and drop it into a category
      container.
   2. To configure the question, click the gear icon in its title bar.
      The Properties dialog box opens.
   3. Complete the form.

   **Question property fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Concise name of the question. The system uses this value to identify the question in Assessment Metric lists and in scorecard charts.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to display as the question on surveys. Enter a clear, straightforward question that is easy to understand.</td>
</tr>
<tr>
<td>Type</td>
<td>Data type selected for this question. See the table in Controls for the available data types.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this question is available on a survey. A question does not appear on surveys that are generated after the question becomes inactive.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box to require users to answer the question. Mandatory questions are denoted by a red field status indicator and must be answered before the survey can be submitted. This field is available when the question does not have a dependency and the question type is not <strong>Boolean</strong> with a check box option.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Allow Additional Information</td>
<td>If selected, the <strong>Additional Information Label</strong> field is enabled. The <strong>Additional Information Label</strong> field value is displayed as a field on the survey response page to provide additional information for a question. Note: This is not applicable for the String and Template data types.</td>
</tr>
<tr>
<td>Boolean option</td>
<td>Whether a check box or a Yes/No list appears as the option for a Boolean question.</td>
</tr>
<tr>
<td>String option</td>
<td>Setting for the appearance of a string field in a question. This field is available when the question type is <strong>String</strong>. The string options include the following.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Single line</strong>: Single-line text field 40 characters in length that allows strings of any length.</td>
</tr>
<tr>
<td></td>
<td>• <strong>String line wide</strong>: Full page width text field that allows a single-line entry of any length.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Multiline</strong>: Full page width multiline text field that allows word wrap and returns</td>
</tr>
<tr>
<td>Min</td>
<td>Lowest positive whole number that users can enter or select to answer the question. This field is available when the question type is <strong>Number</strong>, <strong>Percentage</strong>, or <strong>Numeric Scale</strong>.</td>
</tr>
<tr>
<td>Max</td>
<td>Highest positive whole number that users can enter or select to answer the question. This field is available when the question type is <strong>Number</strong>, <strong>Percentage</strong>, or <strong>Numeric Scale</strong>.</td>
</tr>
<tr>
<td>Allow not applicable</td>
<td>Check box for including <strong>Not Applicable</strong> as an option for this question. Users can select <strong>Not Applicable</strong> if they do not have sufficient information to respond to a question. User responses of <strong>Not Applicable</strong> are excluded from results calculations. This field is available when the question does not have a dependency and the question type is not <strong>Boolean</strong> with a check box option.</td>
</tr>
<tr>
<td>Randomize answers</td>
<td>Check box for displaying answer options in a random order. Answer preference is sometimes influenced by the order in which options appear, which can result in biased results. Randomizing options can help prevent this bias.</td>
</tr>
</tbody>
</table>

**Note:** Randomizing options for certain questions may make those questions confusing for users. In general, only randomize options that do not follow a logical order.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Positive indicator</td>
<td>Setting that determines whether smaller or larger numerical values equate to a good score in result calculations. Select <strong>Low values</strong> if smaller numerical values are better, such as for a question that measures the number of incidents for a vendor. Select <strong>High values</strong> if larger numerical values are better, such as for a question that measures user satisfaction on a scale of one to five.</td>
</tr>
<tr>
<td>Source Field</td>
<td>Source table field that appears as a dynamic value for the question in a triggered survey. When this field value is selected, a ${\text{param}}$ placeholder is added at the end of the question label. <strong>Note:</strong> You can move this placeholder anywhere in the question label. When a user takes the survey, the question with dynamic value is included in the survey instance and ${\text{param}}$ placeholder is replaced with the source field value. If the record table specified in the trigger condition does not match the source table specified for the survey, or if the system fails to get the dynamic value from the source record, the ${\text{param}}$ placeholder is not replaced by any value and is displayed as is in the question. For example, if the survey is triggered from a PRB record and the survey question is configured with a dynamic value from <strong>Incident</strong>, the ${\text{param}}$ placeholder in the survey question label is not replaced by any dynamic value and is displayed as is. <strong>Note:</strong> When survey questions are translated to other languages by a survey admin, the ${\text{param}}$ placeholder should not be translated.</td>
</tr>
<tr>
<td>Allow Sentiment Analysis</td>
<td>Includes this question for the sentiment analysis of a survey. <strong>Note:</strong> This field is available only for String type questions.</td>
</tr>
<tr>
<td>Details</td>
<td>Information about the question that is displayed on the survey. Include details that help users understand how to answer the question.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Choices</td>
<td>Options for a question with a data type of Choice or Scale. The system automatically adds text and values that you can edit for each option. You must have at least two options, and each option must have a unique value. Click the + icon to add an option, or click the X icon to delete an option. By default, the system arranges options in the order established by their values. To change the order, drag and drop the options. <strong>Note:</strong> Value numbers also contribute to the calculations of survey response scores, which can be used by advanced survey administrators.</td>
</tr>
</tbody>
</table>

4. To create any special conditions that must be met before the question appears on the survey, click the Dependency tab. The question must have a data type of Boolean, Choice, Scale, or Template.

5. Select a question in the Displayed when field. The system selects the appropriate operator and displays the possible answers for the selected question.

6. Select the answer that satisfies the condition. You can select more than one answer. Selected answers are indicated by a check mark. The system prevents recursive dependencies between questions. For example, if Question A depends on Question B, Question B cannot depend on Question A.

7. Click the X icon to close the question properties dialog box and save your settings.

8. To add a question with the same data type as an existing question in the category, click the + icon in the title bar of the existing question.

9. Drag and drop questions to change their order within a category or move them between categories.

10. To delete a question, click the X icon in its title bar.

**Survey question data types**

You must choose a data type for each survey question. The data type determines the format of the question and the kind of data that is collected on survey questionnaires.

The following data types are available for surveys:
Attachment data type

On questionnaires, users can attach one or more files to a question.
Users click the Manage Attachments icon and select one or more files in the Attachments pop-up window to attach to the question. From this window, users can:
  • View a list of the attached files.
  • View an attached file in a separate window.
  • Rename an attached file.
  • Add or delete files

Once a survey has been submitted, attachments cannot be updated or deleted.

Any type of file supported by the platform can be attached to a question. One or more files can be attached a question while taking a survey or completing an assessment.

The assessment administrator can see the attachments associated with an individual question as well as those associated with the survey.

See Administering Attachments for more information.

Boolean data type

On questionnaires, users select a check box beside a statement or leave it cleared.

If you select Boolean, you must fill in the Scale definition field. Select High if it is best when users select the check box.

Choice data type

On questionnaires, users select a value from a list of choices.

If you select Choice, you must fill in the Scale definition field and create answer options. Select High for the scale definition if the answer option with the largest metric definition Value is best.
Note: The system sets the Min and Max fields automatically based on the Value settings for the associated metric definitions.

Date and Date/Time data types

The Date and Date/Time data types are similar.

- **Date**: On questionnaires, users select a date.
• **Date/Time**: On questionnaires, users select a date and time.

![Date/Time example](image1.png)

**Likert Scale data type**

On questionnaires, users select a multiple choice value from a custom Likert scale. Each answer option is represented by a radio button on the scale. A Likert scale question that evaluates an application's ease of use might have the answer options **Easy**, **Average**, and **Difficult**.

![Likert Scale example](image2.png)

If you select **Likert Scale**, you must fill in the **Scale definition** field and create answer options. Select **High** for the scale definition if the answer option with the largest metric definition **Value** is best.

**Note**: The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.

**Number data type**

On questionnaires, users enter a number.
If you select **Number**, you must fill in these additional fields:

- **Scale definition**: Select **High** if a larger number is better, such as for a question that measures the number of sales made in a quarter.
- **Min** and **Max**: Enter the smallest and largest numbers users can enter. State the range of acceptable answers in the question text.

**Percentage data type**

On questionnaires, users enter a number.

If you select **Percentage**, you must fill in these additional fields:

- **Scale definition**: Select **High** if a larger percentage is better, such as for a question that measures the percentage of work an agent has completed.
- **Min** and **Max**: Enter the smallest and largest numbers users can enter. Generally **0** and **100** are appropriate minimum and maximum values. If you choose values other than **0** and **100**, it is usually best to state the range of acceptable answers in the question text.

**Reference data type**

On questionnaires, users select a value from a list that is generated from a specified reference table. The response field supports auto-completion.

**Note**: Reference qualifiers are not supported.

For example, a user could select a user name in response to a question if you specify User [sys_user] as the reference table.
String data type

On questionnaires, users enter text. When you select **String**, the **String option** field appears. Select one of the following options to determine how the string field appears on questionnaires:

- Single line
Template data type

On questionnaires, users select a value from a predefined series of answer options. To use this data type, a question template must be defined.

If you select Template, you must fill in these additional fields:

- **Template**: Select a template.
- **Scale definition**: Select High if the answer option with the largest template definition Value is best.

Yes/No data type

On questionnaires, users select Yes or No from a list.

If you select Yes/No, you must fill in the Scale definition field. Select High if Yes is the best answer.
Image Scale data type

On questionnaires, users select an image from a predefined set of images as their response. Image scale questions can also be used in a template for better performance with surveys that have the same type of answer options.

Five emojis, similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Two images can be uploaded, one for selected case and another for unselected case. Larger size images are reduced to 64 x 64 pixels.

The result behavior depends on the presence of uploaded images. If no selected image is uploaded, then the question shows up blank.

<table>
<thead>
<tr>
<th>Selected image</th>
<th>Unselected image</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Unselected image loads. Clicking on the image changes it to the selected image.</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>Selected image loads with 50% opacity. Clicking on the image changes the opacity to 100%.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>A blank placeholder box is displayed.</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>A blank placeholder box is displayed.</td>
</tr>
</tbody>
</table>

Note: N/A option is not supported for image scale type question.

Multiple selection data type

On questionnaires, users can select multiple check boxes indicating all answers that apply. For instance, a user can be instructed to "Select all that apply" in a multiple selection question.
Equation Usage Survey

Multiple Selection

What equipments do you use?
- Laptop
- Tablet
- Smart Phone

**Ranking data type**

On questionnaires, users can select a different order number for each option to rank them. Drag-and-drop functionality is also supported, which allows a user to either fill in the number, or simply drag an option.

1. Please rate following device in order of importance.

One order number cannot be selected twice. This question can be mandatory and it can also be dependent on a parent question, but not vice versa.

*Edit a survey in the survey designer*

You can modify surveys using the survey designer.

Role required: admin or survey_admin
You can edit a survey even after it has been distributed, with the following results.

- Added questions are available only on surveys that are distributed after this change.
- Changes to existing questions are immediately available to users before the survey is submitted or during the retake period. This includes changes to the answers, such as additional choices or changes to the data type.
- Deleted questions are also deleted from the distributed surveys in user queues.

**Note:** You can only edit a survey that has the same application scope as that of your current session.

1. Navigate to **Survey > Survey Designer**.
2. Point to the menu icon in the survey header bar, and select **Load Survey**.
3. Select a survey from the list and modify it as needed.
4. Point to the menu icon in the survey header bar, and select **Save** or **Save and Publish**.
   When you publish the edited survey, the system generates survey instances for any associated survey users.

**Configure category weights for a survey**

You can assign a weight to each category in a survey. The system calculates results from the weight that you configure.

Configure the Survey Category form to display the **Weight** field.

Role required: admin or survey_admin

Weights are set to a value of **10** by default but can be changed.

1. Navigate to **Survey > View Surveys** and select a survey from the list.
2. In the Survey Definition form, select a category from the **Metric Categories** related list.
3. Edit the default weight value.
4. Click **Update**.

**View a survey instance**

A survey instance represents one questionnaire assigned to one user. You view an instance to verify that survey instances were created, to check the state of a survey instance, or to reassign a survey instance.

Role required: admin or survey_admin

1. Navigate to **Survey > Survey Instances**. The following sub-modules are available based on the state of the instances:

   - **Ready to take**: Displays survey instances that are ready to be taken by the user. By default, these instances are sorted in ascending order by the **Number** field.
   - **In progress**: Displays survey instances that are in progress. By default, these instances are sorted in ascending order by the **Number** field.
   - **Completed**: Displays survey instances that are complete. By default, these instances are sorted in descending order by the **Taken on** field.
   - **Cancelled**: Displays survey instances that are cancelled. By default, these instances are sorted in ascending order by the **Number** field.
   - **All**: Displays survey instances in all states. By default, these instances are sorted in ascending order by the **Number** field.
2. Open a survey instance from the required sub-module. By default, the following fields are displayed in the Survey Instance form for all sub-modules other than **Completed**.

**Note:**
- When you open an instance in the **Completed** sub-module, you are redirected to the User's Response page.
- Each survey instance is stored as a record on the Assessment Instance [asmt_assessment_instance] table with a modified view for survey use.

### Survey Instance form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated record number.</td>
</tr>
<tr>
<td>Metric type</td>
<td>Survey definition this survey instance was created from. Survey definitions are stored on the Assessment Instance table, and the field label on that table is <strong>Metric type</strong>.</td>
</tr>
<tr>
<td>Due date</td>
<td>Date by which the survey instance should be completed. The system populates the due date based on the <strong>Assessment duration</strong> of the associated survey definition, which is set to 14 days by default. The survey due date is not enforced in the base system. If you want to enforce the due date, consider using a workflow or other mechanism to send survey recipients reminders when a survey is overdue.</td>
</tr>
<tr>
<td>State</td>
<td>State of the survey instance.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User this survey instance is assigned to. This field becomes read-only when the state is In progress, Complete, or Canceled.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain associated with the instance.</td>
</tr>
<tr>
<td>Expiration date</td>
<td>Date on which the assigned user can receive a new instance of the same survey definition. The system automatically populates the expiration date based on the <strong>Schedule period</strong> of the associated survey definition.</td>
</tr>
<tr>
<td>Related Link</td>
<td>Shows a read-only version of the survey responses completed by the user.</td>
</tr>
<tr>
<td>View User’s Response</td>
<td>Shows a read-only version of the survey responses completed by the user.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry Sentiment Analysis</td>
<td>Sends the survey instances for sentiment analysis.</td>
</tr>
<tr>
<td></td>
<td>Note: This link is available only if any sentiment analysis result is not available for this instance under Survey &gt; Question Sentiment Results</td>
</tr>
</tbody>
</table>

**Survey users and groups**

Survey users and survey user groups help survey administrators control who can take a survey.

Survey administrators can restrict a survey so that only specified users can access it unless a survey administrator manually assigns the survey to a different user. Survey user groups provide a way to quickly designate multiple survey users.

**Administering survey users**

The list of survey users for a survey is visible on the Survey Definition and Survey Category forms. You can add or remove users from the list of survey users at any point. Note that designating a survey user does not automatically generate a survey instance for that user unless both of the following conditions are true:

- The survey definition **Schedule** period is set to **Daily, Weekly, Monthly, or Yearly**. In this case the system assigns a new survey instance to each survey user at the beginning of each schedule period.
- The user has no instances of the survey that are incomplete or that have not yet reached their expiration date.

You can designate survey users from the Survey Designer, the Survey Definition form, or the Survey Category form.

**Note:** If there are trigger conditions for a survey, do not create survey users. Instead, use the Trigger Conditions form to assign users.

**Create a survey user group**

Survey user groups are groups that have the **Type** field set to survey and display only the information most relevant to surveys. You can assign survey groups or any user group to surveys.

Role required: admin or user_admin

Though it is possible to designate members of any group as survey users, one reason to create a survey group is to view it conveniently in the survey **User Groups** module.
By default, the Survey Creators user group is available. When you add a user to this group, the user will be assigned the survey_creator role to create surveys, quizzes, or assessments and view only those surveys, quizzes, or assignments created by the user.

1. Navigate to **Survey > Administration > User Groups**.
2. Click **New**.
3. Complete the Group form.
4. Right-click the form header and click **Save**.
   The **Group Members** and **Groups** related lists appear.
5. To add group members, complete the following steps.
   a) In the **Group Members** related list, click **Edit**.
   b) Select users from the list on the left and add them to the **Group Members List** on the right.
   c) Click **Save**.

**Select recipients for a survey in the Survey Designer**

You can assign survey users while designing or modifying the survey.

Role required: admin or survey_admin

1. In the Survey Designer, click the **Availability** tab.
2. Under **Accessible by**; select the **Specific users** option, then select users.
3. If desired, select the **Survey groups only** check box, then select survey user groups or other groups.
4. Click **Save**.

**Designate a survey user**

You can designate one survey user at a time from the Survey Definition form.

Role required: admin or survey_admin

1. Navigate to **Survey > View Surveys**.
2. Open a survey definition.
   There must be at least one category.
3. In the **Survey Users** related list, click **New**.
4. Select a **User**.
5. Click **Submit**.
   The Survey Definition form reopens.
6. Optional: To remove survey users, in the **Survey Users** related list, select the check box beside the user, and then select **Delete** from the action list below the list.

**Designate or remove multiple survey users at one time**

Use the Survey Category form to designate or remove multiple survey users at a time.

Role required: admin or survey_admin

1. Open a survey definition.
2. In the **Metric Categories** related list, open a category.
   You can choose any category. The system applies survey user changes to all the survey's categories automatically.
3. In the **Users** related list, click **Edit**.
4. Use the slushbucket to add or remove survey users.
5. Click **Save** to return to the survey category.
   The changes are also reflected in the **Survey Users** related list on the survey definition.
Allow recipients to retake a survey
You can configure a survey to allow recipients to resubmit their answers as many times as they like, up to the survey’s due date.
Configure the Survey Definition form to display the Allow retake field. For more information, see Configure the form .
Role required: admin or survey_admin
Results are not calculated for the survey until the configured duration has elapsed. The card in the user's queue remains visible until the due date of the survey, and a button is displayed to allow retakes.
1. Navigate to Surveys > View Surveys.
2. Select a survey from the list.
3. Select the Allow retake check box.
4. Click Update.

Copy a survey
Create a copy of a survey with at least one category to reduce the effort of creating another survey with similar data.
Role required: survey_admin or admin
All associated questions (type), configurations, categories, metrics, domain separation rules, and role-based categories are copied. Assigned users, category users, instances, and trigger conditions are not copied.
1. Navigate to Survey > View Surveys.
2. Open a survey definition.
3. Perform any of the following steps:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Platform</td>
<td>In the title bar, click Copy.</td>
</tr>
<tr>
<td>From Platform</td>
<td>In the title bar, select Copy from the context menu.</td>
</tr>
<tr>
<td>From survey designer</td>
<td>a.  In the title bar, click Survey Designer.</td>
</tr>
<tr>
<td></td>
<td>b.  In the Survey Designer title bar, point to the menu icon (_survey) and click Copy Survey</td>
</tr>
</tbody>
</table>

Publish a survey
You must publish a survey to enable people to receive and complete survey instances.
Role required: admin or survey_admin
The State field on the Survey Definition form indicates whether the survey is in the Draft or Published state.

Note: You cannot return a survey to the Draft state after it has been published. You do have the option to deactivate a survey by clearing the Active check box.

1. Navigate to Survey > View Surveys and select a survey to publish.
2. Click Publish.
When you publish a survey, the system generates survey instances for any associated survey users. You can assign the survey to other users manually.

**Publish a survey in the Survey Designer**

You must save changes to a survey before you can publish it to the specified recipients or groups.

Role required: admin or survey_admin

1. In the Survey Designer, point to the menu and select **Load Survey**.
2. Select a survey to publish.
3. To preview the survey as a user, point to the menu icon and click **Preview**.
4. When you are satisfied with the survey, click either **Save and Publish** or **Publish** to distribute it.

   When you publish a survey, the system sends email notifications to the recipients and to their managers. The system displays a link to the survey on a card in each recipient's My Assessments & Surveys portal.

**Customize the appearance of a survey**

Assessment and survey administrators can set properties to customize the color of various elements on the questionnaires.

Role required: admin or survey_admin

For color properties, enter either an HTML color name or hexadecimal (hex) value. For hex values, the # character is required. Values are not case-sensitive.

For example, all of the following formats are valid: LightGray, lightgray, #D3D3D3. A preview of the color appears next to the field.

Note that the customizations you make apply to all assessments and surveys.

1. Navigate to either of the following modules.
   - Assessments > Admin > Assessment Properties
   - Survey > Administration > Properties
2. On the properties page, edit the properties as needed.
   Refer to the screenshot below to see what parts of assessment questionnaires are controlled by the properties.
3. **Click Save.**
   You may need to clear the browser's cache to see updates.

### Assessment and survey properties

You can configure a variety of properties to customize the appearance of assessment and survey questionnaires, require authentication for user signatures, open surveys in the service portal view from emails, and limit the number of items shown in a decision matrix field filter.

#### Assessment and survey properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_portal_surveys.sp_survey.email_redirection | Allow survey link from email to open in service portal view (applies only for surveys) | When Yes is selected, a survey accessed from a link in an email opens in the Service Portal.  
**Note:** This property applies only to surveys.  
• Default value: No |
| com.snc.assessment.signature_authentication | Require authentication for user signature. | When Yes is selected, this property requires credentials for a full name signature.  
• Default value: Yes |
| css.assessment.question.header.background.color | Assessment question header background color | Sets the background color of question headers on assessment and survey questionnaires.  
• Default value: #767676 |
| css.assessment.caption.background.color | Assessment caption background color | Sets the background color of the caption on assessment and survey questionnaires.  
• Default value: #ffffff |
| com.snc.assessment.decision_matrix_filter_max_entries | Maximum number of items to show for a decision matrix field filter | • Default value: 1000 |
| css.assessment.caption.font.color | Assessment caption font color | Sets the font color of the caption text on assessment and survey questionnaires.  
• Default value: #ffffff |

#### Survey definitions

A survey definition is the root record upon which a survey is built.

The survey designer generates a survey definition automatically when you save or publish the survey. Survey administrators may want to modify the survey definition to configure additional options for the survey, or to publish the survey when it is ready for distribution.
Survey administrators and survey readers can also send survey invitations directly to users from the survey definition.

Modify a survey definition
You can configure additional options for a survey definition.

Role required: admin, survey_creator, or survey_admin

1. Navigate to Survey > View Surveys.
   Each survey definition is stored as a record on the Assessment Metric Type [asmt_metric_type] table with a modified view for survey use.

2. Open a survey definition. The Response Trend chart with the weekly trend of the survey instance count, and the Survey Summary chart with the overall summary response based on instance states are displayed.

3. Modify the fields on the Survey Definition form.

   Note: You can only edit a survey that has the same application scope as that of your current session.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the survey which appears on the questionnaire.</td>
</tr>
<tr>
<td>Description</td>
<td>Helpful information about the survey.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the survey definition. When the Active check box is cleared, new survey instances cannot be generated and users cannot complete existing survey instances. Use the Active check box to deactivate or activate a published survey.</td>
</tr>
<tr>
<td>Owners</td>
<td>Owners of the survey. You can add a user with the survey_creator, survey_admin, or assessment_admin role.</td>
</tr>
<tr>
<td>Anonymize responses</td>
<td>Check box to ensure that all responses for this survey are stored without the submitting user names. When a user submits a survey, the system clears the Assigned to field for the associated survey instance. Also, survey responses for anonymous surveys do not contain Assigned to values.</td>
</tr>
<tr>
<td>Send notifications</td>
<td>Check box to send a notification that the survey has been taken.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the survey: Draft or Published.</td>
</tr>
</tbody>
</table>

Note: The Assigned to field is cleared. However, each response record includes the Created By and Updated By fields that are accessible to users with the survey_admin role.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow retake</td>
<td>Check box that allows users to modify their answers to a completed survey. Users can resubmit a survey as many times as they want until the due date. After that date, the system removes the survey from the user's My Assessments &amp; Surveys page.</td>
</tr>
</tbody>
</table>
| Scheduled job | Scheduled job that the system creates for this survey definition when the schedule period is a repeating interval. The system sets the scheduled job to run according to the selected schedule period. If you change the schedule period and save the survey definition:  
• The system deletes the old scheduled job.  
If you selected a recurring schedule period:  
• A new scheduled job is created.  
For example, if you change the schedule period from **Daily** to **Weekly** and save the record:  
• The system deletes the daily scheduled job.  
• Creates a weekly one set to run a week from the current date.  
This field is visible to administrators only if the schedule period is **Daily**, **Weekly**, **Monthly**, or **Yearly**.                                                                                                                                                                                                                                                                                                                                 |
| Assessment duration | The length of time to complete assigned survey instances, starting from the time the survey instance is generated. The assessment duration sets the Due date for each survey instance. The default duration is 14 days. Configure the form to view this field.  
**Note:** By default, the system runs the **Cancel Expired Assessments** script every 30 days to cancel expired survey, assessment, and quiz instances that are in the Work in progress or Ready to take states.                                                                                                                                                                                                                                                                 |
| Send notifications | send notifications for the survey when it is published. Configure the form to see the field.                                                                                                                                                                                                                                                                                                                                                                                                                                      |
| Other Options |                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                   |
| Sample Metric | A metric of the current survey that you can include as an image in the email or invitation sent to a survey user. When the survey user clicks the image in the email or while previewing the HTML body, the entire survey is available to be taken.  
**Note:** You cannot edit or delete a metric that is selected in this field.                                                                                                                                                                                                                                                                                                                                                                                  |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Signature                 | Acknowledgement by a survey recipient of requirements, admonitions, or policies related to the survey. The signature may require the recipient to select a check box or to type in a full signature to verify having read these assertions. You can display assertions without requiring a signature. Select an existing signature from the list or click New to create a new one. The signature form contains these fields:  
  • **Name**: Descriptive name for this signature.  
  • **Signature type**: Type of signature required. The selections are **Check box**, **Full name**, or **Assertion only**. If **Assertion only** is selected, no signature is required to submit the survey.  
  • **Assertion**: Text you want to display to recipients. By default, a property called **Require authentication for user signature** (com.snc.assessment.signature_authentication) requires users to authenticate when providing a full name signature. |
| Schedule period           | Option that determines how often a user can take the same survey and whether the system generates survey instances on a schedule. Note: If you use a trigger condition for a survey, ensure the schedule period is set to **No Limit**. Trigger conditions use a different method to regulate how often users can receive survey instances. |
| Do not show survey intro. | Check box to skip the introduction notes when a survey is launched. This functionality is applicable in both the Now Platform and Service Portal product versions.                                                                 |
| Pagination setting         | The setting on which the pagination is based for desktop or tablet view in Service Portal.  
  • **Category**: default  
  • **Question**: 1 question per page (automatic for mobile)  
  • **None**: no pagination  
  Note: This field is displayed only when Service Portal is installed. |
| One Click Survey           | Enables a One Click survey in Service Portal.  
  Note: This option can be selected if the **Pagination setting for Service Portal view** is set to **None**.                                                                                     |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Table</td>
<td>Table whose field is used as a dynamic value for a question in a triggered survey.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When you select a source table, ensure that its relevant field is selected as Source Field value of a metric.</td>
</tr>
<tr>
<td>Outlook Actionable Message</td>
<td>Includes an embedded survey in the survey email notification. After you select this check box and save the survey, a validation is run to ensure all survey questions are supported.</td>
</tr>
<tr>
<td>Allow Sentiment Analysis</td>
<td>Enables sentiment analysis for this survey.</td>
</tr>
<tr>
<td>Introduction &amp; End Notes</td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>Introductory content to display on survey questionnaires. Consider adding a company logo, a welcome message, background information about the survey, or instructions.</td>
</tr>
<tr>
<td>End note</td>
<td>End note that appears when someone submits a survey questionnaire. Consider adding a thank you message, follow-up instructions, or other applicable information.</td>
</tr>
<tr>
<td>Related Links</td>
<td></td>
</tr>
<tr>
<td>Enable Public Access</td>
<td>Link that enables/disables the survey as a public survey. No login is required to take a public survey (including a survey with a trigger condition) and users or non-users can respond anonymously. For completed public surveys, the Assigned to field value is Guest.</td>
</tr>
<tr>
<td>Remove Public Access</td>
<td><strong>Note:</strong> You can use the View Survey URL related link to share the URL with users.</td>
</tr>
<tr>
<td>View Responses</td>
<td>Link that opens the list of responses for this survey. This related link is available only if there are results for the survey.</td>
</tr>
<tr>
<td>View Scorecard</td>
<td>Link that opens the scorecard for this survey. This related link is available only if there are results for the survey.</td>
</tr>
<tr>
<td>View Survey URL</td>
<td>Link that opens a dialog box that displays a URL for this survey. The URL is useful for sharing a public survey. This related link is available only if the Active check box is selected. The URL does not work until the survey definition is published.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Benchmarks</td>
<td>Opens the Benchmarks Dashboard that provides visibility into your key performance indicators (KPIs) and trends.</td>
</tr>
</tbody>
</table>
|                              | **Note:**  
  • This related link is available only for survey_admin, assessment_admin and survey_reader with bm_viewer role.  
  • You must opt in to Benchmarks to view the dashboard. See Enable Benchmarks  
  • This is applicable only for a published survey.                                                                                               |
| Create Improvement Initiative| Opens the Improvement Initiative window to create an improvement initiative record that helps in improving the performance of the survey.                                                                            |
|                              | **Note:**  
  • This related link is available only for the survey_admin and assessment_admin role. A survey_reader can only view the created improvement initiative records.  
  • You should activate the Continual Improvement Management plugin (com.sn_cim).                                                                |
| Retry Sentiment Analysis     | Checks all survey instances of this survey that do not have sentiment analysis data and sends them for analysis.                                                                                               |
| Related Lists                |                                                                                                                                                                                                            |
| Trigger Condition            | Displays all the trigger conditions associated with the survey.                                                                                                                                              |
| Survey Responses             | Displays all the responses associated with the survey.                                                                                                                                                      |
| Metric Categories            | All survey categories for this survey.                                                                                                                                                                       |
| Survey Users                 | All survey users who are authorized to take this survey. If no users are listed, any user can take this survey.                                                                                               |
| Assessment Instances         | All survey instances for this survey. Configure the form to add this related list to see it.                                                                                                                 |
|                              | **Note:** If you add a related list to the form, use list control to omit the New button. The system generates survey instances to produce functional surveys.                                                 |
## Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improvement Initiatives</td>
<td>Displays improvement initiatives associated with the survey.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This related list is available only when there is at least one improvement initiative record.</td>
</tr>
<tr>
<td>Survey Recipients Lists</td>
<td>Recipients lists that are added to the survey.</td>
</tr>
</tbody>
</table>

4. Save the record.

### Schedule periods

The available schedule periods are **Only Once, No Limit, Daily, Weekly, Monthly, and Yearly**.

The default schedule period is **No Limit**. When you set the schedule period to anything except **Only Once** or **No Limit**, the system creates a corresponding scheduled job. The scheduled job performs the following actions:

- Ensures that a user can take one survey instance of the same survey per schedule period.
- Generates a new survey instance for each survey user at the beginning of the new schedule period, as long as the survey user does not have an incomplete instance of that survey. A survey instance is incomplete if the state is not **Complete**.

For example, if you set the schedule period to **Weekly** and someone attempts to send survey invitations twice in the same day, the system generates survey instances for the survey users the first time only. At the beginning of the next schedule period, the system generates another survey instance for each survey user who completed the previous one.

Schedule periods are enforced by the **Expiration date** field on the survey instance. As long as the survey instance expiration date has not passed, the assigned user cannot receive a new survey instance. When the system generates a survey instance and the schedule period is anything except **No Limit**, the **Expiration date** field is automatically set to the appropriate date. For example, if the schedule period is **Weekly**, the expiration date is a week after the survey instance is generated.

If you change the schedule period, the scheduled job updates automatically to the correct schedule. However, users who have survey instances for the survey cannot receive new survey instances until their existing survey instances expire, regardless of the new schedule period.

Consider the following example: Sal Pindell receives a survey instance when the schedule period is **Weekly**. The next day, a survey administrator changes the schedule period to **No Limit**. Sal cannot receive another survey instance until one of the following actions occurs:

- Seven days pass from the time Sal's survey instance was generated.
- A survey administrator deletes Sal's survey instance.

After one of these actions occurs, Sal can receive a new survey instance anytime, as long as he has no incomplete instances of the survey.

**Note:** If you use a trigger condition for a survey, ensure the schedule period is set to **No Limit**. Trigger conditions use a different method to regulate how often users can receive survey instances.

---

Create a survey designer template question

You can create a question that uses choice lists from a template.
Role required: admin or survey_admin

1. Navigate to Survey > Survey Designer and load a survey or create a new survey.
2. Drag the Template data type icon into a category container.
3. Click the gear icon in the question title bar to open the template properties dialog box.
4. Select a predefined scale from the list.

Question entry fields appear for that template.
5. Enter one or more questions that are appropriate for the template.
6. Click the arrow to the right of a question to configure its properties. You must provide a name for each question.

7. Click the back arrow to return to the template properties dialog box.
8. Configure the properties for the remaining questions.
9. Click the X icon to close the template properties dialog box and save your settings.

Survey questions

Survey questions appear on survey questionnaires for the associated survey definition. The survey creator generates questions and answer options automatically. However, it provides only the basic configuration options for questions, such as the question text and the data type. You may want to create additional questions or set advanced configuration options for the questions, including making a question appear conditionally or making a question mandatory. You can also use question templates to define reusable sets of answer options.

Survey questions are available from Survey > Questions. The list displays information about each question, including the associated survey definition listed in the Type column, and the data type. Survey administrators can modify these questions.
Create or modify survey questions
You can create and administer survey questions.

Role required: admin or survey_admin

Changes to a survey, such as the addition of questions or the modification of question templates, do not apply immediately to the existing survey instances. However, the changes apply immediately to any new survey instances that are created after the changes are saved.

1. Navigate to Survey > View Surveys.
2. Open a survey definition.
3. In the Metric Categories related list, open a category.
4. In the Assessment Metrics related list, open an existing question or click New.
   Each survey question is stored as a record on the Assessment Metric [asmt_metric] table with a modified view for survey use.
5. Complete the Survey Question form.
   The fields that appear depend on the selected Data type.

**Survey Question form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the question. When you create a survey, the question name is the same as the text in the Question field.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to use for the question, which appears on survey questionnaires.</td>
</tr>
<tr>
<td>Data type</td>
<td>Data type of the question. The fields for the response depend on the data type.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If another question depends on this question, you cannot change the data type.</td>
</tr>
<tr>
<td>Template</td>
<td>Question template to use for the answer options. This field is visible and required only if the data type is Template.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If another question depends on this question, you cannot change the template.</td>
</tr>
<tr>
<td>Scale definition</td>
<td>Setting that determines whether smaller or larger numerical values equate to a good score in result calculations. Select Low if smaller numerical values are better, such as for a question that measures the number of incidents for a vendor. Select High if larger numerical values are better, such as for a question that measures user satisfaction on a scale of one to five. This field is visible and required only when certain data types are selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Randomize answers</td>
<td>Check box that determines whether to present the answer options for this question in a random order each time a user opens the survey. Answer preference is sometimes influenced by the order in which answer options appear, which can result in biased results. Randomize answer options to help prevent this bias. This field is visible only if the data type is <strong>Choice</strong> or <strong>Likert Scale</strong>. <strong>Note:</strong> Randomizing answer options may make a question confusing. In general, only randomize answer options that do not follow a logical order.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box that makes the question mandatory (selected) or optional (cleared) on survey questionnaires. Users cannot submit questionnaires until they provide valid responses to all mandatory questions, which are denoted by a red field status indicator. This field is visible only when the <strong>Depends on</strong> field is empty and the data type is not <strong>Checkbox</strong>. Questions that depend on other questions and check box questions cannot be mandatory.</td>
</tr>
<tr>
<td>Allow not applicable</td>
<td>Check box that determines whether to include a <strong>Not Applicable</strong> answer option for this question on survey questionnaires. User responses of <strong>Not Applicable</strong> are excluded from results calculations. This field is visible only if the data type is <strong>Choice</strong>, <strong>Likert Scale</strong>, <strong>Template</strong>, or <strong>Yes/No</strong>.</td>
</tr>
<tr>
<td>Allow Additional Information</td>
<td>If selected, the <strong>Additional Information Label</strong> field is enabled. The <strong>Additional Information Label</strong> field value is displayed as a field on the survey response page to provide additional information for a question. <strong>Note:</strong> This is not applicable for the String and Template data types.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depends on</td>
<td>Setting used to make this a conditional question, meaning that it only appears when users answer another question a certain way.</td>
</tr>
<tr>
<td></td>
<td>To make a question depend on another question, select an existing question from the list, which displays <strong>Checkbox</strong>, <strong>Choice</strong>, <strong>Template</strong>, and <strong>Yes/No</strong> questions of the same category as this question. Then, use the <strong>Displayed when</strong> field to set the conditions that cause this question to appear on surveys.</td>
</tr>
<tr>
<td></td>
<td>The system prevents the creation of recursive dependencies between questions. For example, if Question A depends on Question B, Question B cannot depend on Question A.</td>
</tr>
<tr>
<td>Displayed when</td>
<td>Answer options for the selected <strong>Depends on</strong> question which, when chosen on surveys, display this question. This field is visible and required only when the <strong>Depends on</strong> field is set.</td>
</tr>
<tr>
<td>Min</td>
<td>Smallest numerical value to be used as an answer option for this question. This field is visible and required only if the data type is <strong>Choice</strong>, <strong>Likert Scale</strong>, <strong>Number</strong>, or <strong>Percentage</strong>.</td>
</tr>
<tr>
<td>Max</td>
<td>Largest numerical value to be used as an answer option for this question. This field is visible and required only if the data type is <strong>Choice</strong>, <strong>Likert Scale</strong>, <strong>Number</strong>, or <strong>Percentage</strong>.</td>
</tr>
<tr>
<td>String option</td>
<td>Selection that determines what kind of response text box appears for this question on survey questionnaires. This field is visible and required only if the data type is <strong>String</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source Field</td>
<td>Source table field that appears as a dynamic value for the question in a triggered survey. When this field value is selected, a <code>${param}</code> placeholder is added at the end of the question label.</td>
</tr>
<tr>
<td></td>
<td>Note: You can move this placeholder anywhere in the question label.</td>
</tr>
<tr>
<td></td>
<td>When a user takes the survey, the question with dynamic value is included in the survey instance and <code>${param}</code> placeholder is replaced with the source field value.</td>
</tr>
<tr>
<td></td>
<td>If the record table specified in the trigger condition does not match the source table specified for the survey, or if the system fails to get the dynamic value from the source record, the <code>${param}</code> placeholder is not replaced by any value and is displayed as is in the question.</td>
</tr>
<tr>
<td></td>
<td>For example, if the survey is triggered from a PRB record and the survey question is configured with a dynamic value from Incident, the <code>${param}</code> placeholder in the survey question label is not replaced by any dynamic value and is displayed as is.</td>
</tr>
<tr>
<td></td>
<td>Note: When survey questions are translated to other languages by a survey admin, the <code>${param}</code> placeholder should not be translated.</td>
</tr>
<tr>
<td>Allow Sentiment Analysis</td>
<td>Includes this question for the sentiment analysis of a survey.</td>
</tr>
<tr>
<td></td>
<td>Note: This field is available only for String type questions.</td>
</tr>
<tr>
<td>Related Lists</td>
<td></td>
</tr>
<tr>
<td>Assessment Metric Definitions</td>
<td>Answer options for this question. This related list is available only if the Data type is Choice or Likert Scale.</td>
</tr>
</tbody>
</table>

6. Save the record.

**Note:**
- Be sure to create answer options if you select the Choice or Likert Scale data type.
- You cannot delete a survey question (metric) with user responses. To delete a survey question with user responses, you should delete the responses, and then delete the survey question.
Survey question data types
You must choose a data type for each survey question. The data type determines the format of the question and the kind of data that is collected on survey questionnaires.

The following data types are available for surveys:

Attachment data type

On questionnaires, users can attach one or more files to a question. Users click the Manage Attachments icon and select one or more files in the Attachments pop-up window to attach to the question. From this window, users can:

- View a list of the attached files.
- View an attached file in a separate window.
- Rename an attached file.
- Add or delete files

Once a survey has been submitted, attachments cannot be updated or deleted.

Any type of file supported by the platform can be attached to a question. One or more files can be attached a question while taking a survey or completing an assessment.

The assessment administrator can see the Attachments associated with an individual question as well as those associated with the survey.

See Administering Attachments for more information.

Boolean data type

On questionnaires, users select a check box beside a statement or leave it cleared.

If you select Boolean, you must fill in the Scale definition field. Select High if it is best when users select the check box.

Choice data type

On questionnaires, users select a value from a list of choices.
If you select **Choice**, you must fill in the **Scale definition** field and create answer options. Select **High** for the scale definition if the answer option with the largest metric definition **Value** is best.

**Note:** The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.

### Date and Date/Time data types

The **Date** and **Date/Time** data types are similar.

- **Date:** On questionnaires, users select a date.
• **Date/Time:** On questionnaires, users select a date and time.

![Date/Time example](image)

**Likert Scale data type**

On questionnaires, users select a multiple choice value from a custom Likert scale. Each answer option is represented by a radio button on the scale. A Likert scale question that evaluates an application's ease of use might have the answer options **Easy**, **Average**, and **Difficult**.

![Likert Scale example](image)

If you select **Likert Scale**, you must fill in the **Scale definition** field and create answer options. Select **High** for the scale definition if the answer option with the largest metric definition **Value** is best.

**Note:** The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.

**Number data type**

On questionnaires, users enter a number.
If you select **Number**, you must fill in these additional fields:

- **Scale definition**: Select **High** if a larger number is better, such as for a question that measures the number of sales made in a quarter.
- **Min** and **Max**: Enter the smallest and largest numbers users can enter. State the range of acceptable answers in the question text.

### Percentage data type

On questionnaires, users enter a number.

If you select **Percentage**, you must fill in these additional fields:

- **Scale definition**: Select **High** if a larger percentage is better, such as for a question that measures the percentage of work an agent has completed.
- **Min** and **Max**: Enter the smallest and largest numbers users can enter. Generally 0 and **100** are appropriate minimum and maximum values. If you choose values other than 0 and **100**, it is usually best to state the range of acceptable answers in the question text.

### Reference data type

On questionnaires, users select a value from a list that is generated from a specified reference table. The response field supports auto-completion.

**Note**: Reference qualifiers are not supported.

For example, a user could select a user name in response to a question if you specify User `sys_user` as the reference table.
String data type

On questionnaires, users enter text. When you select **String**, the **String option** field appears. Select one of the following options to determine how the string field appears on questionnaires:

- Single line
Template data type

On questionnaires, users select a value from a predefined series of answer options. To use this data type, a question template must be defined.

If you select Template, you must fill in these additional fields:

- **Template**: Select a template.
- **Scale definition**: Select **High** if the answer option with the largest template definition **Value** is best.

Yes/No data type

On questionnaires, users select **Yes** or **No** from a list.

If you select **Yes/No**, you must fill in the **Scale definition** field. Select **High** if **Yes** is the best answer.
Image Scale data type

On questionnaires, users select an image from a predefined set of images as their response. Image scale questions can also be used in a template for better performance with surveys that have the same type of answer options.

Five emojis, similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Two images can be uploaded, one for selected case and another for unselected case. Larger size images are reduced to 64 x 64 pixels.

The result behavior depends on the presence of uploaded images. If no selected image is uploaded, then the question shows up blank.

<table>
<thead>
<tr>
<th>Selected image</th>
<th>Unselected image</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Unselected image loads. Clicking on the image changes it to the selected image.</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>Selected image loads with 50% opacity. Clicking on the image changes the opacity to 100%.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>A blank placeholder box is displayed.</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>A blank placeholder box is displayed.</td>
</tr>
</tbody>
</table>

Note: N/A option is not supported for image scale type question.

Multiple selection data type

On questionnaires, users can select multiple check boxes indicating all answers that apply. For instance, a user can be instructed to "Select all that apply" in a multiple selection question.
Ranking data type

On questionnaires, users can select a different order number for each option to rank them. Drag-and-drop functionality is also supported, which allows a user to either fill in the number, or simply drag an option.

One order number cannot be selected twice. This question can be mandatory and it can also be dependent on a parent question, but not vice versa.

Survey question template

Question templates define reusable sets of answer options for survey questions.

Question templates define reusable rating scales for answering questions, where each answer option on the scale is a template definition. For example, the template named **Satisfaction** represents a satisfaction
Template definition

Templates are available for survey questions that have Data type set to Template. The following question templates are available in the base system. You can create or update a template as described in Create a survey question template.

<table>
<thead>
<tr>
<th>Name</th>
<th>Template definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>None, Few or little, Average amount, Many, Quite a lot</td>
</tr>
<tr>
<td>Complexity</td>
<td>Very Complex, Complex, Moderate, Simple, Very Simple</td>
</tr>
<tr>
<td>Frequency</td>
<td>Never, Seldom, Sometimes, Most of the time, All of the time</td>
</tr>
<tr>
<td>Likert 5</td>
<td>Strongly Disagree, Disagree, Neutral, Agree, Strongly Agree</td>
</tr>
<tr>
<td>Quality</td>
<td>Very Poor, Poor, Average, Good, Very Good</td>
</tr>
<tr>
<td>Satisfaction</td>
<td>Very Dissatisfied, Dissatisfied, Neutral, Satisfied, Very Satisfied</td>
</tr>
<tr>
<td>Size</td>
<td>Very Small, Small, Average, Large, Very Large</td>
</tr>
</tbody>
</table>

Create a survey question template
You can create and administer question templates.

Role required: admin or survey_admin

Changes to a survey, such as the modification of question templates, apply to existing survey instances immediately. Templates that you create are available for use with both surveys and assessments.

1. Navigate to Survey > Templates.
   Each template is stored as a record on the Assessment Metric Template [asmt_template] table.
2. Click New.
3. Enter a Name.
4. Right-click the form header and click Save.
5. In the Assessment Template Definitions related list, click New.
   Create a template definition for each answer option you want to appear on a question.
6. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Enter the text to appear as the answer option.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter a numeric value, greater than or equal to zero, to which the answer option equates. Values are used in results calculations. When you view questions that use templates, answer options appear in order from smallest to largest Value. Each template definition for a given template must have a unique Value.</td>
</tr>
</tbody>
</table>

7. Click **Update**.

**Update min and max values to match templates**

If you use survey result calculation data, ensure that the **Min** and **Max** values for a question that uses a template are equal to the smallest and largest template definition **Value**.

Role required: admin or survey_admin

When you create a question of the **Template** data type, the system sets the **Min** and **Max** fields based on the template definition values. The fields for existing questions are not updated if you add a new template definition to a template or if you update the **Value** of an existing template. If the new **Value** is less than the minimum value or greater than the maximum value of any questions that use the template, update the questions accordingly.

1. Navigate to **Survey > Questions**.
2. Configure the list to show the **Min** and **Max** columns.
3. Add the following list filter condition: `[Template] [is] [select the template you updated]`.
4. Ensure the **Min** and **Max** values match the smallest and largest template definition **Value** for the selected template.
   If the values do not match, edit the **Min** and **Max** values directly from the list.

**Note:** When the data type is **Template**, a UI policy prevents the editing of **Min** and **Max** from the form.

**Add a metric category and metric in the question bank for surveys**

Reuse the question categories (metric categories) and questions (metrics) added in the question bank for surveys. You can add metric categories or metrics from the question bank to a survey, or from the survey to a question bank.

Role required: admin or survey_admin

Activate the Survey Question Bank Sample Data plugin (com.snc.question_bank_data) to access the demo data for the question bank.

1. Navigate to **Survey > Question Bank**.
2. Click **New**.
3. In the Metric Category form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the metric category.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the metric category.</td>
</tr>
</tbody>
</table>
4. Right-click on the title bar and click Save.
5. In the Assessment Metrics related list, click New.
6. In the Survey Question form, fill the fields. For information on these fields, see Create or modify survey questions.
7. Click Submit.

Configure metric categories or metrics for a survey using the question bank

Reuse question categories (metric categories) and questions (metrics) from the Question Bank module while creating or updating a survey.

Role required: admin or survey_admin

Activate the Survey Question Bank Sample Data plugin (com.snc.question_bank_data) to access the demo data for the question bank.

1. Navigate to Survey > View Surveys.
2. Open a survey definition.
3. Optional: To add metric categories to a survey from the question bank in Platform, perform the following steps.
   a) In the Metric Categories related list, click New Category from Bank.
      The New Category from Bank dialog box is displayed with a list of all metric categories added in the question bank.
   b) Select the required categories and click Add Selected.
      A copy of the metric category and the corresponding metric definitions is created in the Metric Categories related list.

4. Optional: To add metrics to a survey from the question bank in Platform, perform the following steps.
   a) In the Metric Categories related list, open a metric category definition.
   b) In the Assessment Metrics related list, click New Metric from Bank.
      The New Metric from Bank dialog box is displayed with a list of questions available in the question bank.
   c) Select the required metrics and click Add Selected.
      A copy of the metric and the corresponding metric definitions is created in the Assessment Metrics related list of the category.

5. Optional: To add a metric category to the question bank from a survey in Platform, perform the following steps.
   a) In the Metric Categories related list, open a metric category definition.
   b) Click Add to question Bank.
      A copy of the category is created along with its metrics and metric definitions in the question bank.
6. Optional: To add a metric to the question bank from a survey in Platform, perform the following steps.
   a) In the Metric Categories related list, open a metric category definition.
   b) In the Assessment Metrics related list, open the required metric definition.
   c) Click Add to Question Bank.
      The Add to Question Bank dialog box is displayed.
   d) In the Choose a question bank to add this question/metric field, select a metric category that you want to add this metric to, and click OK.
      A copy of the metric and the corresponding metric definitions is created for the selected category in the question bank.

7. Optional: To add a metric category or metric to a survey from the question bank in Survey designer, perform the following steps.
   a) Open the survey in Survey Designer.
   b) Optional: To add a metric category from the question bank, from the Categories tab in the left panel, drag the required category banner and drop in the Design tab.
   c) Optional: To add a metric from the question bank, drag and drop the required metric from the Questions tab or the Categories tab.

Note:
- When you drag and drop a metric category, all dependencies within the category are also added to the survey.
- From the Categories tab, you can drag and drop an individual metric within a metric category.
- When you drag and drop a parent metric, all dependent questions are also added to the metric category.
- When you drag and drop a child metric, only the child question is added to the metric category.

Create or modify answer options
You must create answer options, called metric definitions, for survey questions that have Data type set to Choice or Likert Scale.

Role required: admin or survey_admin

Changes to a survey, such as the addition or modification of answer options, apply to existing survey instances immediately.
1. Navigate to Survey > Questions.
2. Open a choice or Likert scale survey question.
3. In the Assessment Metric Definitions related list, open a metric definition or click New.
   Each answer option is stored as a record on the Assessment Metric Definition [asmt_metric_definition] table.
4. Complete the Assessment Metric Definition form.

Assessment Metric Definition fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Text to appear as the answer option.</td>
</tr>
</tbody>
</table>
## Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Numeric value, greater than or equal to zero, to which the answer option equates. Values determine the order in which answer options appear. See the example below. Values are also used to calculate survey results. Each metric definition for a given question must have a different <strong>Value</strong>.</td>
</tr>
</tbody>
</table>

5. **Click Submit.**

On survey questionnaires, the answer options for a question appear in order from smallest to largest **Value**. For example, consider the survey question **How do you feel?** with the answer options **Good**, **Neutral**, and **Bad**. The following table shows the answer option order based on the **Value**.

### Answer option order based on value

<table>
<thead>
<tr>
<th>Answer option</th>
<th>Value</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td>1</td>
<td>First</td>
</tr>
<tr>
<td>Neutral</td>
<td>3</td>
<td>Second</td>
</tr>
<tr>
<td>Bad</td>
<td>5</td>
<td>Third</td>
</tr>
</tbody>
</table>

If you use survey result calculations, ensure the question **Scale definition** is set appropriately based on the answer options. In the previous example, if you want the answer option **Good** to earn the highest score, the scale definition should be **Low** because **Good** has the smallest value.

### Change the order of survey questions

You can easily reorder survey questions at the category level or the question level.

**Role required:** admin or survey_admin

You can change the order in which the questions in one category appear relative to those in other categories for the same survey definition. If you add a new question manually after you create other questions, you may want to change the order of questions.

When you create questions using the survey creator, the system sets the **Order** field for the first question to **101**, the second to **102**, and so on. After you create a new question outside of the survey creator, the **Order** is set to **100** by default, which means it appears before all questions generated by the survey creator.

1. **Navigate to Survey > View Surveys** and open the appropriate survey definition.
2. **In the Metric Categories related list,** edit the values in the **Order** column.
3. **To change the order of questions within a category,** complete the following steps.
   a) **Open the Assessment Metrics related list.**
   b) **Edit the values in the Order column.**
4. **Click Update.**

### Survey trigger conditions

Trigger conditions specify when to send a particular survey and the persons to send it to.
Survey administrators can use trigger conditions to configure the system to generate a survey instance each time a specified action occurs on a specified table, for example, when an incident or change request closes. The system sends the survey to users that are related to the triggering record, for example, incident callers or change request assignees. You can choose to send a survey every time the condition is met, or you can set a probability for the system to send a survey at random when the condition is met.

Trigger conditions are ideal for sending transactional surveys. Transactional surveys generally measure satisfaction with a recent experience, such as closing an incident or purchasing an item.

**Note:** Trigger conditions are comparable to survey conditions in legacy surveys. If you migrate a legacy survey that has survey conditions, ensure that the survey conditions are deactivated before you recreate them as trigger conditions.

**Configure trigger condition for a survey**
Configure trigger conditions to specify when to send a particular survey and the persons to send it to.

Role required: admin or survey_admin

1. Navigate to **Survey > Trigger Conditions**.
2. Click **New**.

**Note:** Do not specify particular users for a triggered survey because only the specified users are allowed to take the survey.

3. Complete the form.

<table>
<thead>
<tr>
<th>Trigger condition fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment</td>
<td>Survey to send.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to run the trigger condition on. You can select only tables in the current application scope. For example, to send a survey whenever an incident closes, select the Incident [incident] table.</td>
</tr>
<tr>
<td>User field</td>
<td>Field that stores the users you want to send the survey. You can select any field, on the selected table or on a referenced table, that references the User [sys_user] table. Use the tree picker to select a field. <strong>Note:</strong> To avoid requiring users to log in to take a survey with a trigger condition, set the survey to <strong>Public</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Repeat interval</td>
<td>Minimum period that must pass before the trigger condition can resend the survey to the same user. For example, assume the repeat interval is set to 30 days. Even if the same user qualifies for multiple surveys from this trigger condition, the system can send only one survey every 30 days.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Ensure that the Schedule period of the selected survey definition is set to <strong>No Limit</strong>. If the schedule period is set to a different value, it prevents the trigger condition from sending surveys as expected.</td>
</tr>
<tr>
<td>Application</td>
<td>[Admin only] Application is set to Core.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this trigger condition is active (selected).</td>
</tr>
<tr>
<td>Business rule</td>
<td>[Admin only] Business rule the system creates to monitor the selected table. When the condition is met, the business rule sends the survey to the correct user. No configuration is necessary for this business rule.</td>
</tr>
<tr>
<td>Trigger randomly</td>
<td>Check box that determines whether to send the survey to the appropriate user every time the condition is met (cleared) or only a percentage of the time (selected).</td>
</tr>
<tr>
<td>Probability (%)</td>
<td>Approximate probability that the survey is sent each time the condition is met. For example, if the probability is set to 50, the system sends the survey approximately 50% of the time the conditions are met. There are no repeat interval restrictions is assumed. This field is visible and required only when <strong>Trigger randomly</strong> is selected.</td>
</tr>
<tr>
<td>Related Field 1 - 4</td>
<td>Field that contains a value you want to store for reporting purposes. You can pick any reference field on the selected table. When the trigger condition generates a survey instance, the system stores the value from the triggering record. Specify up to four fields. For example, select the Incident table, <strong>Assigned to</strong> and <strong>Problem</strong> as related fields. The system stores the assigned user and problem associated with the incident as Related record 1 and Related record 2 in the survey instance record. To view the fields, configure the form for any survey instance.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot use a related field for the ticket number because you cannot select the Number column. You can, however, use the trigger_id column of the table.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Summary information to identify the trigger condition.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For a triggered record, the table title is used for the survey description.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition builder that defines the criteria that must be true to send the survey. For example, to send a survey whenever an incident closes, create the condition [State] [is] [Closed].</td>
</tr>
</tbody>
</table>

You can also create a trigger condition directly from the survey creator. If you select **Certain users can take this survey, based on conditions** in the Survey User Access section, the Trigger Condition form opens automatically when you click **Save as Draft** or **Publish**.
Trigger condition example
You can send out auto-triggered surveys when an incident is closed or resolved.

A trigger condition is configured as follows:

- **Assessment**: Service Desk Satisfaction Survey
- **Table**: Incident [incident]
- **User field**: Caller
- **Repeat interval**: 30 days
- **Active**: true
- **Trigger randomly**: false
- **Related Field 1**: Assigned to
- **Related Field 2**: Problem
- **Condition**: [State] [is] [Closed] [or] [State] [is] [Resolved]

Fannie Steese is the caller on incident INC00004305 that is assigned to Boris Catino, a service desk technician. Boris creates PRB010101 based on Fannie's complaint and closes the incident. The system creates a survey instance assigned to Fannie so she can rate her satisfaction with the incident experience.

Because two related fields were selected as part of the trigger condition, the survey instance stores the following information from the incident:

- **User** (Related Field 1): Boris Catino
- **Problem** (Related Field 2): PRB010101
- **Task** (automatically created): INC00004305

Because the task field is automatically populated, UI-based filtering by dot-walking on incidents (or any task-based table) is supported when creating a report on survey results. For example, you can query all survey instances related to incidents assigned to a group (survey reports on all incidents assigned to networking group, for instance).

**Note**: Even though the trigger condition is set to be triggered each time that the conditions are met, the Repeat interval setting ensures that Fannie does not receive another survey for another of her incidents closes within 30 days of the first incident.

Survey report example based on task field

One of the most common use cases for Surveys is to send out an auto-triggered survey when an incident, request, or task is closed. Once you get the survey results back, you can filter the results by users and groups related to the ticket, such as Assignment Group, or Assignee.

Filtering the survey results provides more detail on how people and teams are performing based on ticket data. Since this information is automatically captured, you can dot-walk while filtering the data (instead of utilizing a related field on the Survey trigger condition form, as previously required).
To create a report on incident-triggered survey responses by Assignment group, set up the report on the Task Assessment Details by navigating to Reports View/Run and clicking Create a report.

Survey distribution

There are several ways for survey administrators to distribute surveys to users.

Surveys are distributed using any of the following methods.

- Send survey invitations to users
- Share a survey URL that opens the survey directly.
- Create a module that opens a survey.

Send survey invitations to users

You can send survey invitations using the Assign Survey or Send Invitations buttons on the Survey Definition form.

Role required: admin or survey_admin

Use the Send Invitations button to immediately assign survey instances to each survey user that is listed in the survey definition. Use the Assign Survey button to assign a survey instance to any one user at a time.

Each of the buttons generates survey instances assigned to the appropriate users. In addition, if the instance is configured to send email, the system generates survey notifications. For either button to be available, the survey definition must meet all of the following conditions.

- Active check box is selected.
- State is Published.
- Survey is associated with at least one question.

Note: You (or a trigger) can send more than one instance of a survey to a user at any time.

1. Navigate to Survey > View Surveys.
2. Select an active, published survey.
3. Complete one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign a survey to users listed in the Survey Users related list</td>
<td>Click Send invitations.</td>
</tr>
<tr>
<td>Assign a survey to any user</td>
<td>Click Assign Survey and select one or more users, and then click OK.</td>
</tr>
</tbody>
</table>

The system creates a survey instance assigned to the user or users, assuming the user is eligible to receive a new survey instance. When you use the Assign Survey button, the selected user is not saved as a survey user.

**Define a recipients list for surveys**

Use a recipients list to define targeted set of users for whom the survey invite can be sent. You can use a recipients list for multiple surveys.

Role required: admin or survey_admin

1. Navigate to Survey > Administration > Recipients Lists.
2. Click New.
3. In the Recipients List form, add the field information:

**Recipients List form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the recipients list.</td>
</tr>
</tbody>
</table>
| Type  | Type of users to include in the list. Possible values are:  
• Contacts  
• Internal Users |
| State | State of the recipients list.  
• **New**: List has not yet been generated.  
• **In Progress**: List is currently being generated. (You can see this state only when generating a very large list of recipients.)  
• **Complete**: List is generated. |
| Setup | Method used to generate the recipients list. Possible values are:  
• **Upload File**: Upload an Excel file with the recipients list using the specified template.  
• **Dynamic Condition**: Run a script or condition builder to create the recipients list. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose File</td>
<td>Allows you to download an Excel template, and then upload the Excel file with user information using the specified template.</td>
</tr>
</tbody>
</table>
|               | **Note:**  
|               | • This field is available only if the **Method** is **Dynamic Condition**.  
|               | • The templates vary based on the entity selected in the **Type** field. For accounts, the template includes columns for sys_id and account number values. For contacts, consumers, and internal users, the template includes columns for sys_id and email values. |
| Show Script   | If selected, displays the script to create the recipients list.                                                                                           |
|               | **Note:** This field is available only if the **Method** is **Dynamic Condition**.                                                                             |
| Script        | Script to create the recipients list.                                                                                                                     |
|               | **Note:** This field is available only if the **Method** is **Dynamic Condition** and the **Show Script** check box is selected.               |
| Table         | Table that stores the user information. The table is selected based on the **Type** field.                                                                  |
|               | **Note:** This field is available only if the **Method** is **Dynamic Condition**.                                                                            |
| User Field    | Table field that refers to users.                                                                                                                         |
|               | **Note:** This field is available only if the **Method** is **Dynamic Condition**.                                                                            |
## ServiceNow DocVersion Now Platform capabilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditions</td>
<td>Condition builder to create the recipients list based on the specified table and user field. A condition is made up of a selected field, an operator, and a value. Add conditions using the AND and OR buttons. Delete conditions by clicking the Delete button to the right of a condition.</td>
</tr>
</tbody>
</table>

**Note:** This field is available only if the Method is Dynamic Condition.

---

4. **Click Submit.**
   - For recipients lists created by the file upload, clicking Submit validates the records in the Excel file. Following validation, the system displays a pop-up window with the upload results, including valid and invalid user records.

5. **Optional:** To get the updated user list, navigate to the recipient list and click **Refresh Recipient List**.

### Add a recipients list to a survey

Send the survey invites to targeted sets of users by adding a recipients list to a survey.

**Role required:** admin or survey_admin

Recipients lists should be pre-defined in the Recipients Lists submodule. For more information on defining recipients lists, see **Define a recipients list for surveys**.

1. **Navigate to Survey > View Surveys.**
2. **Open a survey definition.**
3. **Perform any of the following steps.**

#### Option |
| Description |

<table>
<thead>
<tr>
<th>From Platform</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>Under the Survey Recipients Lists related list, click <strong>New</strong>.</td>
</tr>
<tr>
<td>b.</td>
<td>In the Survey Recipients Lists form, from the Recipients List list, select the required recipients list. Click <strong>Submit</strong>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>From Survey Designer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>Under the Availability tab, for the Accessible By field, select Specific users.</td>
</tr>
<tr>
<td>b.</td>
<td>In the Add recipients lists list, select the required recipients list.</td>
</tr>
<tr>
<td>c.</td>
<td>To send the survey to users, click <strong>Save and Publish</strong>.</td>
</tr>
</tbody>
</table>

4. **To send survey invites to all survey users and recipients lists, click **Send Invitations**.**

**Note:**
Embed a survey within the Outlook email client
Embed an interactive survey in the email notification sent to a user. The user can answer the survey questions and submit the survey from the email client instead of opening the survey in a new browser tab.

Role required: admin or survey_admin

The Outlook Actionable Messages plugin (com.sn_ms_oam) should be activated.

**Note:**
- Outlook Actionable Message (OAM) is not supported for Outlook 2016 for Mac. For information about detailed support matrix, refer to the Microsoft website.
- Actionable messages are supported only for emails sent from the @service-now.com email address. If you are sending an email from a customized email address, you should register as a new service in the Microsoft website setting the scope as Organization. Specify the provider ID value in the sn_ms_oam.outlookactionable.originator property.
- Actionable messages are based on the Sender Policy Framework (SPF)/DomainKeys Identified Mail (DKIM) validation for the email sender verification. If an email recipient receives email via an external provider, emails may are not rendered as adaptive cards.
- You cannot customize the default actionable message templates.

1. Navigate to **System Notification > Email > Notifications**.
2. For the Survey User Invite notification, in the **What it will contain** tab, add the following script in the **Message** field in addition to the existing information:

   ```
   ${mail_script:include_survey_actionable}
   ```

   This script includes the Outlook actionable message in the email notification sent to the user.
3. Navigate to **Survey > View Surveys**, and open a survey.
4. To send an email notification to the survey user, select the **Send notifications** check box.
5. Select the **Outlook Actionable Message** check box and save the survey.

**Note:**
- The following questions are not supported for an embedded survey:
  - Attachment
  - Date
  - Datetime
  - Template
  - Reference
  - Image Scale
  - Ranking
- Dependant questions are not supported.
- Signature is not supported.
In both the Platform UI and Survey Designer, a validation is run to ensure all survey questions are supported.

6. Click Assign Survey and assign the survey to a user. An email notification with the embedded survey is sent to the user. The user can take the survey and submit it from the email client instead of opening the survey in a new browser tab.

Enable localization for a survey
Enable a survey user to take a survey in multiple languages.
Role required: admin or survey_admin

The plugin for the language that you want the survey to be available in should be installed.

Note: Localization is applicable only for public surveys.

1. Navigate to Survey > Administration > Properties.
2. Enable the Enable/Disable whether to show language picker when a public survey is taken (show_lang_picker_for_publicsurveys) property.
3. In the System Settings window, from the Language list, select the language that you want the survey to be available in.

Note: The Language list is available only when a language plugin is installed.

4. Navigate to Survey > View Surveys and open a public survey.
5. Enter the translated text for the survey title, questions, and answers.
6. Save and publish the survey.

Note: The localization is also applicable in Service Portal if the Assessment Properties Allow survey link from email to open in service portal view (applies only for surveys) (sn_portal_surveys.sp_survey.email_redirection) property is enabled.

- The survey is available for survey users in the translated language.
- Users can change the language of the survey using the language picker.

Survey URLs
You can distribute a survey by giving survey users a survey URL.

Survey administrators can obtain one of the following types of URLs.

- A general URL for a survey, which users can open to take the survey questionnaire. The following process occurs.
  - When someone opens the URL, the system ensures that the person is logged in. It then searches for an instance of the associated survey that is assigned to the logged-in user.
  - If a survey instance is found, the appropriate action occurs based on the State of the survey instance (see table). If there are multiple active survey instances (Ready to take or In progress), the instance with the earliest due date opens.
  - If no survey instance is found, the system creates a new instance for the survey, assigns it to the user, and opens the survey questionnaire.
• A URL for a specific survey instance, which the assigned user can open to take the survey questionnaire. The following process occurs.
  • When someone opens the URL, the system ensures the person is logged in as the user the survey instance is assigned to. Only the assigned user can access the survey questionnaire.
  • The appropriate action occurs, depending on the State of the survey instance (see table).

<table>
<thead>
<tr>
<th>Survey instance state</th>
<th>Action upon opening URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready to take: User has not saved any responses.</td>
<td>The survey questionnaire appears for the user to begin. The user can save or submit responses.</td>
</tr>
<tr>
<td>In progress: User has saved at least one response.</td>
<td>The survey questionnaire appears for the user to continue. Any previously saved responses are displayed. The user can save or submit responses.</td>
</tr>
<tr>
<td>Complete: User has submitted all required responses.</td>
<td>If the schedule period is No Limit or if the period restriction has expired, the survey questionnaire for a new survey instance appears for the user to begin. If the schedule period restricts the number of times a user can take the same survey, and the period restriction has not expired since the user last completed survey, an error message appears.</td>
</tr>
</tbody>
</table>

If someone opens a URL for an unpublished or deactivated survey, an error message appears.

Obtain and distribute a general survey URL
You can distribute a general survey URL to allow any eligible user to open a survey questionnaire.

Role required: admin or survey_admin

The general URL is available on the Survey Definition form and on the survey creator. You can also email the URL for a public survey that is published.

1. Navigate to Survey > View Surveys.
2. Open a survey definition from the Assessment Metric Types list.
3. To view or copy the URL, click the View Survey URL related link.
   This related link is visible only if the survey definition is Active.
4. To distribute the URL to users, paste the copied URL as desired, or click the Email button to send via email.
   The Email button is visible only for a public survey that is published.

When a survey user clicks the general survey URL, the system creates a survey instance for the survey user as long as the user does not have an instance in the Ready to take state. The system is configured by default to send an email notification when a survey instance is generated.

As a result, the survey user receives a second notification in addition to the notification that you sent with the general survey URL. This may confuse the survey user. To avoid this issue, you can deactivate auto-notification.

Deactivate auto-notification for surveys
When you send a survey notification with a general survey URL to a survey user, the user may receive a second system-generated notification. To avoid this issue, you can deactivate auto-notification.
Role required: admin or survey_admin

1. Navigate to **System Notification > Email > Notifications**.
2. Open the **Survey User Invite** notification.
3. Configure the form to add the **Send to event creator** check box to the Who will receive section.
   - The **Send to event creator** check box is selected by default.
4. Clear the **Send to event creator** check box.
   - The system will no longer send auto-notification messages to survey users.

**Obtain a survey instance URL**
You can distribute a survey instance URL to allow the assigned user to open a survey questionnaire.

Role required: admin or survey_admin

The survey instance URL is available on the survey instance record.

1. Navigate to **Survey > Survey Instances**.
2. Open the instance for the survey.
3. To view or copy the URL, click **View Instance URL** related link.
   - The related link is available only when the survey instance **State** is **Ready to take** or **In progress** and the associated survey definition is **Active**.
4. In the dialog box, select and copy the URL then click **OK** or **Cancel**.
5. Distribute the URL to the assigned user.

**Test a survey URL**
When there are survey users associated with a survey, the survey is restricted so only those users can use the survey URL. You can test the survey URL to ensure it is restricted.

Role required: admin or survey_admin

1. Navigate to **Survey > View Surveys** and open a survey for which you are not a survey user.
2. Under **Related Links**, click **View Survey URL**.
3. Copy the URL and click **OK** or **Cancel**.
4. Navigate to the URL.
   - You see a message that you are not authorized to take the survey.

**Create a survey module**
You can create a module that opens a survey.

Role required: admin or survey_admin

When a user clicks a survey module, the system performs one of the following actions, depending on the configuration options for the survey and other factors.

- Creates a new survey instance
- Opens an existing survey instance
- Displays an error message.

1. Perform the appropriate action for your version of the UI:
   - UI16: Point to the application menu that contains the module to which you want to add the survey module and click the edit application (pencil) icon.
   - UI15: Right-click the application menu you want to add the module to and select **Edit Application Menu**
2. In the **Modules** related list, click **New**.
3. Complete the following fields.
   - **Link type:** Assessment
     Do not select **Survey**, which is used for legacy surveys only.
   - **Assessment:** Select the survey you want the module to open.

4. Complete and save the form.

**Sharing surveys: export and import**
You can export a survey and then import it to a different ServiceNow instance.

*Note:* Update sets are available in the Helsinki release and should be used to move data from one instance to another. For information about update sets, see System update sets.

The system exports a single XML file that contains a survey definition [asmt_metric_type] and the associated records, including the following.
- Assessment Metric Template [asmt_template]
- Assessment Template Definition [asmt_template_definition]
- Metric definitions [asmt_metric_definition] (survey question answer options)
- Scheduled Jobs associated with the Survey [sys_trigger]
- Survey categories [asmt_metric_category]
- Survey questions [asmt_metric]
- Survey users [asmt_m2m_category_user]
- Trigger Condition [asmt_condition]

**Export a survey**
You can export a survey and then import it to another instance.

Role required: admin, survey_reader, or survey_admin

For information about update sets, see System update sets.

1. Navigate to **Survey > View Surveys**.
2. Right-click the name of a record to show the context menu.
3. Select **Export Assessment**.
4. If applicable, follow the prompt in your browser to save the XML file.

**Import a survey**
You can import a survey that has been exported as an XML file. The exported XML file does not contain result data.

Role required: admin or survey_admin

*Note:* Update sets are available in the Helsinki release and should be used to move data from one instance to another. For information about update sets, see System update sets.

1. Verify that the target instance has assessments enabled.
2. Follow the steps in #unique_2742 to import the assessment.

**Use update sets for surveys and assessments**
Use an update set to capture changes to surveys and assessments.

Role required: admin or survey_admin
When developing surveys and assessments, you can use an update set to capture the changes and move them from a development instance to a production instance. Once an update set is created and marked current, all of the updates to the following tables are recorded in the update set.

The following tables are now update set enabled and also extend the application file:

- Assessment Metric Templates [asmt_template]
- Assessment Template Definitions [asmt_template_definition]
- Assessment Metric Definitions [asmt_metric_definition]: survey question answer options
- Schedule [sys_trigger]: scheduled jobs associated with the survey
- Assessment Metric Categories [asmt_metric_category]: survey categories
- Assessment Metrics [asmt_metric]: survey questions
- Assessment Category Users [asmt_m2m_category_user]: survey users
- Trigger Conditions [asmt_condition]

Configure a survey in the Connect chat support
Enable a user to take a survey after chatting with a survey agent.

Role required: admin or survey_admin

Note: The Connect Support plugin (com.glide.connect.support) should be activated.

1. Navigate to Survey > Chat survey.
2. Click New.
3. In the Chat Survey form, fill the fields.

Chat Survey form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey</td>
<td>Survey whose instance should be available in Connect Support.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of chat where the survey is available.</td>
</tr>
<tr>
<td></td>
<td>• Connect: Survey is available in Connect Support.</td>
</tr>
<tr>
<td>Chat queue</td>
<td>Chat queue where the survey is available.</td>
</tr>
<tr>
<td>Active</td>
<td>Specifies if the chat survey configuration is active.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the chat survey configuration.</td>
</tr>
</tbody>
</table>

4. Click Submit.
   When a support agent of the assignment group associated with the chat queue ends a chat with a user, the survey instance is available in the chat window for the users.

Sentiment analysis for surveys

You can use sentiment analysis to determine whether user responses for a survey are considered positive, negative, or neutral.

Activate the Sentiment Analysis (com.snc.sentiment_analysis) plugin.

For a survey, you can select questions that should be used for analysis. The survey responses of these questions are sent to the thirdparty platforms for analysis through the specified connector configurations.
The sentiment analysis results are displayed under Survey > Question Sentiment Results. The sentiment label is based on the normalized score:

<table>
<thead>
<tr>
<th>Normalized score</th>
<th>Sentiment label</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1 to 0</td>
<td>Negative</td>
</tr>
<tr>
<td>0</td>
<td>Neutral</td>
</tr>
<tr>
<td>0 to 1</td>
<td>Positive</td>
</tr>
</tbody>
</table>

**Configure a sentiment connector**

Specify the service URL and other configuration information for third party APIs that are used for sentiment analysis.

Role required: admin

1. Change the scope of the current session to Sentiment Analysis.
2. Navigate to Sentiment Analysis > Sentiment Connector Configurations.
3. Add or edit the connector configuration for a third party vendor such as Google, IBM Watson, and MS Azure.

Note: By default, placeholders are available for configuring connectors for Google, IBM Watson, and MS Azure.

**Sentiment connector fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the sentiment analysis connector configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the connector configuration.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias associated with the connector configuration. It has a reference to the system level table (sys_alias_list).</td>
</tr>
<tr>
<td>Default</td>
<td>Check box to make this as the default connector configuration.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the connector configuration.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to call the Sentiment Analysis API and the normalize the values.</td>
</tr>
</tbody>
</table>
4. Configure the connector credentials
   a) Open the record referred in the **Credential Alias** field.
   b) Under the **Connections** tab, select the connection.
   c) In the **Connection URL** field, enter the value.
   d) Open the record referred in the **Credentials** field.
   e) Enter the credential information.

   **Note:**
   - You should obtain the connection credentials from the respective third-party vendors.
   - If the credential is an API key, specify its value. If the credential is basic authentication, that is, user name and password, specify the corresponding information.

   f) Select the **Active** check box and click **Update**.

5. Select the **Active** check box for the connector configuration and click **Update**.

**Sentiment analysis properties**
You can use the sentiment analysis properties to customize the **Sentiment Analysis** module.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response time for the outbound call of Sentiment Analysis API (sn_nlp_sentiment.glide.sentiment.transaction.timeout)</td>
<td>Maximum time (milliseconds) expected for executing the outbound call for Sentiment Analysis API before timeout.</td>
</tr>
</tbody>
</table>

**Sentiment analysis results**
The sentiment analysis results view contains a bar chart that displays the percentage of positive, negative, and neutral results, along with the instance count for each category.

**Color indicators**
Following are the color indicators in the bar chart:
- Green: Positive
- Red: Negative
- Blue: Neutral

**Quick start tests for Assessments and Surveys**
Validate that Assessments and Surveys still work after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.
Assessments and Surveys quick start tests require activating the Automated Test Framework Survey plugin (com.glide.automated_testing_impl.Survey).
### Legacy survey migration

Users with the `survey_admin` role can migrate legacy survey data to create copies of legacy surveys and their related records in assessment tables. The Survey Management application, which is built on the assessment engine, is available as an alternative to legacy surveys.

The following legacy survey components are migrated:

- Survey masters
- Supported survey questions and question choices
- Survey instances
- Survey responses

Legacy survey conditions are not migrated and must be recreated as trigger conditions.

#### Note:

- The **Legacy Surveys** and **Legacy Administration** modules are available on instances upgraded from a previous release but not available for new instances. Customers using legacy survey or survey wizard should plan to migrate to the Survey Management application to create modern and high quality surveys for their users.
- The following legacy survey plugins are inactive by default, and are available upon request:
  - Best Practice - Task Survey Management (ID: com.snc.bestpractice.task_survey)
  - Survey Management (ID: com.glideapp.survey)
  - Assessment Components (ID: com.snc.assessment)
  - Survey Wizard (ID: com.glideapp.survey_wizard)
- Survey wizards cannot be migrated.

#### Migrate a legacy survey

Migrate a legacy survey and its related records to take advantage of a more powerful feature set.

Role required: admin or `survey_admin`

To avoid timing out for very large surveys, you can disable the transaction quota. See #unique_2750.

1. **Navigate to Survey > Legacy Surveys > Masters.**
   
   The list of legacy survey masters appears. By default, the list shows only survey masters that have not been migrated. To show all survey masters, remove the Assessment is empty breadcrumb.

2. **Open a survey and click the Migrate to New Survey Management related link or Migrate to New Survey Management in the title bar.**
A dialog box describes what happens when you migrate the survey. Note that certain types of survey questions cannot be migrated.

3. **Click OK.**
   The system generates records on assessment tables based on the survey master, eligible questions and choices, results, and other related survey components. The original survey components are unaffected.

   System messages may appear at the top of the Survey form to notify you of questions that could not be migrated and to advise you to review migrated **Multiple Choice** questions.

4. **Optional:** Click the reference icon beside the **Assessment** field to view the new survey definition.

5. **Optional:** Remove survey users from the assessment survey if you want all users to be able to take it. When you migrate a survey, any users who have taken it are automatically associated with the assessment survey and become survey users. When there are survey users associated with an assessment survey, only those users can take it.

6. **Deactivate any survey conditions associated with the survey by completing the following steps.**
   a) Navigate to **Survey > Legacy Administration > Survey Conditions.**
   b) In the **Active** column, ensure the value is false for any survey conditions that reference the migrated survey.

7. **Navigate to Survey > Administration > Trigger Conditions** to create new trigger conditions for the migrated survey.

   The **Migrate to Assessment** related link on the legacy survey record becomes unavailable after the migration. However, if you delete the record referenced in the **Assessment** field, the related link reappears and you can migrate the legacy survey again.

   **Survey question migration**

   Before you migrate a legacy survey, understand that some legacy survey questions cannot be migrated due to incompatible question types.

   Legacy survey questions are migrated from the Survey Question [survey_question_new] table to the Assessment Metric [asmt_metric] table. In legacy surveys, the **Type** field on the Survey Question table determines how the question renders on the survey questionnaire. In assessment surveys, the **Data type** field on the Assessment Metric table serves a similar purpose. Certain legacy survey types are not supported in assessment surveys.

   The following table shows the conversion path for each legacy survey question type to an assessment data type, if there is one.

   **Survey question migration**

<table>
<thead>
<tr>
<th>Legacy survey type</th>
<th>Assessment data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Break</td>
<td>Not available</td>
</tr>
<tr>
<td>CheckBox</td>
<td>Checkbox</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date/Time</td>
</tr>
<tr>
<td>HTML</td>
<td>Not available</td>
</tr>
<tr>
<td>Label</td>
<td>Not available</td>
</tr>
<tr>
<td>List Collector</td>
<td>Not available</td>
</tr>
<tr>
<td>Lookup Multiple Choice</td>
<td>Not available</td>
</tr>
<tr>
<td>Lookup Select Box</td>
<td>Not available</td>
</tr>
</tbody>
</table>
## Legacy survey type | Assessment data type
---|---
Macro | Not available
Macro with Label | Not available
Multi Line Text | String (String option set to **Multiline**)
Multiple Choice | Likert Scale
Numeric Scale | Number
Reference | Not available
Select Box | Choice
Single Line Text | String (String option set to **Single line**)
UI Page | Not available
Wide Single Line Text | String (String option set to **Single line wide**)
Yes / No | Yes/No

### Migrated components
When you migrate a survey, the system maps records from survey tables to assessment tables.

To create a functional survey on the assessment framework, the system converts survey records to the most logical equivalent assessment survey records. This may mean multiple assessment survey records represent one legacy survey record.

### Migrated components

<table>
<thead>
<tr>
<th>Survey component</th>
<th>Assessment survey components</th>
</tr>
</thead>
</table>
| Survey master [survey_master]    | • Survey definition [asmt_metric_type]  
                                  | • Assessable record [asmt_assessable_record], for system use only  
                                  | • Survey category [asmt_metric_category]                                                     |
| Survey question [survey_question_new] | • Survey question [asmt_metric]                                                              |
| Question choice [question_choice] | • Assessment metric definition [asmt_metric_definition]                                      |
| Survey instance [survey_instance] | • Assessment group [asmt_assessment], for system use only  
                                  | • Survey instance [asmt_assessment_instance]                                                 |
| Survey response [survey_response] | • Survey instance question [asmt_assessment_instance_question]  
                                  | • Survey response [asmt_metric_result]  
                                  | • Category result [asmt_category_result], for system use only                              |
**Migrated question review**

To maintain accurate result calculations, you may need to make minor adjustments to some of the migrated survey records to ensure results are calculated correctly.

**Note:** The assessment engine provides a built-in result calculation feature that converts each survey response to a score between 0 and 10. The configuration required to maintain accurate result calculations is advanced and is not recommended for basic survey implementations. If you do not plan to use result calculation data, ignore the information in this section.

For each legacy question migrated, the system creates a survey question record on the Assessment Metric [asmt_metric] table. For legacy questions of the Multiple Choice and Select Box types, the system also creates a metric definition record, on the Assessment Metric Definition [asmt_metric_definition] table, for each legacy question choice.

### Comparable metric definitions and survey question choices

<table>
<thead>
<tr>
<th>Survey question choice field</th>
<th>Related metric definition field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Display</td>
</tr>
<tr>
<td>Value (can be any string value)</td>
<td>Value (must be a numerical value)</td>
</tr>
<tr>
<td>Order</td>
<td>Value (metric definition with smallest Value is first)</td>
</tr>
</tbody>
</table>

When the system migrates legacy survey question choices, it uses the legacy Order to set each metric definition Value. For the legacy question choice with the smallest Order, the corresponding metric definition Value is set to 1. For the legacy question choice with the next smallest Order, the metric definition Value is 2, and so on.

The Scale definition field on the migrated Survey Question form determines whether smaller or bigger metric definition values equate to a good score in survey result calculations. By default, the scale definition is set to High, meaning bigger values are good. When you migrate a legacy survey, check that the default scale definition makes sense for each question.

For example, the following tables depict a sample migrated question and the metric definitions automatically created for it. Recall that the system uses the order of the legacy survey question choices to set the metric definition value. **Excellent** has the lowest Order value, so when the system creates a metric definition for this question choice, the Value is set to 1. In this case the default scale definition value, High, does not make sense, as the system will calculate the worst scores for responses of Excellent.

#### Legacy question: Please rate the overall quality of your service.

<table>
<thead>
<tr>
<th>Question choice text</th>
<th>Question choice value</th>
<th>Question choice order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excellent</td>
<td>A</td>
<td>100</td>
</tr>
<tr>
<td>Good</td>
<td>B</td>
<td>200</td>
</tr>
<tr>
<td>Fair</td>
<td>C</td>
<td>300</td>
</tr>
<tr>
<td>Poor</td>
<td>D</td>
<td>400</td>
</tr>
</tbody>
</table>

#### Migrated question: Please rate the overall quality of your service.

<table>
<thead>
<tr>
<th>Metric definition display</th>
<th>Metric definition value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excellent</td>
<td>1</td>
</tr>
<tr>
<td>Good</td>
<td>2</td>
</tr>
</tbody>
</table>
If there are no Order values for the legacy survey question choices, the system sets each corresponding metric definition Value based on the alphanumeric order of the legacy Text value.

**Metric definition display** | **Metric definition value**
--- | ---
Fair | 3
Poor | 4

You may also need to change the Scale definition setting for other migrated questions. For details, see the scale definition recommendations for each survey question data type.

### Quizzes

Quizzes are questionnaires you can assign to one or more users to assess their knowledge of any subject. The quiz functionality is built on the assessment engine and provides many of the same features as assessments and surveys.

Each question is scored, and the overall score indicates the percentage of questions the user answered correctly. A quiz may have categories of questions that are assigned only to some users. You can assign weighting values to individual questions or categories of questions that make them more or less important when calculating the overall score. Quizzes require activation by a system administrator.

- An administrator can create a quiz for any purpose and assign it to a single user or multiple users.
- A quiz can contain one or more categories of questions. Each category can be assigned to users who answer only the questions in that category.
- The system can send email notifications to these users:
  - **Recipients**: The recipient can receive notification of an assigned quiz, a quiz whose allowed duration is at 50%, and a quiz that is overdue.
  - **Recipient's manager**: The recipient's manager can receive notification when a quiz is overdue.
  - **Quiz manager**: The quiz manager can receive notification of an overdue quiz to which he or she is assigned.

- Quizzes can contain questions that are scored or not scored. Unscored questions assess opinions or involve dates and are not counted in the final score. Scored questions specify correct answers and are scored either as 0% or 100%. You can apply a weighting scale to scored questions to establish their relative importance. You can designate questions with these data types as scored questions:
  - Checkbox
  - Choice
  - Duration
  - Likert Scale
  - Numeric Scale
  - Template
• Yes/No

• A quiz question can be dependent on the response to any scored question. For example, you can create a dependent question requesting additional information that appears only if a recipient answers No to a specific question.

Important terms

The quiz application involves several terms.

<table>
<thead>
<tr>
<th>Terms used in quiz application</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes</td>
<td>A quiz contains information such as duration, state, and notification controls and lists the existing categories. Text fields on the quiz form allow an administrator to create introductory content and end notes that are displayed to the recipient.</td>
</tr>
<tr>
<td>Categories</td>
<td>A quiz category represents a theme for quiz questions. Each category contains one or more questions and names the recipients for the questions in that category. By default, the system creates one category with the same name as the quiz. You can create additional categories as needed. Categories can be weighted higher or lower to determine the importance of that category in the overall score.</td>
</tr>
<tr>
<td>Questions</td>
<td>A quiz question is a question configured for a category and sent only to the users for that category. Questions have a wide variety of data types and can be individually weighted higher or lower. Questions may be scored or unscored.</td>
</tr>
<tr>
<td>Category user</td>
<td>A category user is the recipient of questions for a specific category. You can select different users to answer the questions for each category.</td>
</tr>
<tr>
<td>Templates</td>
<td>A template is a question data type that provides reusable rating scales for answers to questions. For example, the answer template named Satisfaction contains a satisfaction scale ranging from Very Satisfied to Very Dissatisfied.</td>
</tr>
</tbody>
</table>

Quiz roles

The Quizzes application uses these roles. No role is required to take quizzes that are assigned to you.
Quiz roles

<table>
<thead>
<tr>
<th>Role Title [Name]</th>
<th>Role Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>assessment administrator [assessment_admin]</td>
<td>Can administer the Assessments application and all quiz records. Can access all the modules of the Assessments application.</td>
</tr>
<tr>
<td>Administrator [admin]</td>
<td>Can access all aspects of the assessment and survey processes. Only administrators can modify survey notifications, create survey modules, and import surveys.</td>
</tr>
</tbody>
</table>

Note: The itil_admin role and the survey_admin role contain the assessment_admin role

Set up and administer quizzes

Set up and administer quizzes.

Role required: assessment_admin or admin

1. Optional: Create reusable question templates for quizzes.
2. Create the quiz using the Quiz Designer or with forms accessed from the navigation menu.

   The quiz record includes specifics such as duration, notification preferences, a questionnaire introduction, and ending notes displayed to recipients.
3. Edit the default category or create additional categories as needed.

   The system creates a category with the same name as the quiz.
4. Define users for each category.

   These are the recipients who answer the questions in a category. You can define different users for each category.
5. Create the questions for each category.
6. Create the answers for each question and determine if the questions are scored.

   You can create unique answers or select preconfigured answers from a template.

Publish and distribute the quiz. You can send the quiz to a single user or all users in each category.

Review the results from the submitted quizzes in reports and scorecards.

Activate the quiz designer

Administrators can activate the Quiz Designer plugin.

Role required: assessment_admin or admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: **Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>**.

### Quiz Overview module

The Quiz Overview module is a homepage that displays various reports on data such as results for each category and quizzes that are complete, pending, or in progress.

**Role required:** assessment_admin or admin

Users with the assessment_admin role can view the overview page and refresh, add, delete, and rearrange widgets.

1. Navigate to **Quizzes > Overview**.
2. Click elements within reports to obtain more information. The available reports are:

<table>
<thead>
<tr>
<th>Report</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes by State</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
</tr>
<tr>
<td>Total Questions by Quiz</td>
<td>Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Questions by Data Type</td>
<td>Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Correct Answers by Assigned User</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Number of Correct Answers</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Incorrect Answers by Assigned User</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Number of Incorrect Answers</td>
<td>Metric Results [asmt_metric_result]</td>
</tr>
</tbody>
</table>

### Quiz designer

The quiz designer provides a single interface that users with the assessment_admin role can use to create, edit, and distribute quizzes.

You can also use it to edit existing quizzes and change scoring parameters.

Alternatively, you can use the modules of the assessment engine to create and edit the records that make up a quiz. All quiz records are stored in assessment tables and displayed in Quiz views of those tables. For details, see **Create quizzes with forms**.

### Tools on the Quiz Designer

The quiz designer includes a design canvas, a header bar, and many controls that you can use to create quizzes.

To open the quiz designer, navigate to **Quizzes > Quiz Designer**.

The designer contains the following elements:

- Controls tab
- Questions tab
- Categories tab
- Header bar
• Design canvas

Controls tab

Controls for the supported question data types are available in the Controls palette. Drag and drop a control onto the designer canvas to create a question of that type.
## Question controls

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
<th>Scored</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Question with a Manage Attachments icon that allows users to attach one or more files.</td>
<td>Y</td>
</tr>
<tr>
<td>Boolean</td>
<td>Question with a check box or a Yes/No list for user responses.</td>
<td></td>
</tr>
<tr>
<td>Choice</td>
<td>List of predefined options. For more information, see the definition for <a href="#">Choices Create quiz questions.</a> Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Date</td>
<td>Date field.</td>
<td>N</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date and time field.</td>
<td>N</td>
</tr>
<tr>
<td>Number</td>
<td>Number field with predefined minimum and maximum values. The default is 1-10.</td>
<td>N</td>
</tr>
<tr>
<td>Percentage</td>
<td>Percentage field with a prescribed range.</td>
<td>N</td>
</tr>
<tr>
<td>Scale</td>
<td>Predefined Likert scale. Answer options appear as radio buttons. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Numeric Scale</td>
<td>Selectable number scale. The default is 1-5. Answer options appear as radio buttons. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Image Scale</td>
<td>Predefined set of images. Five emojis similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>String</td>
<td>Single or multiline text field.</td>
<td>N</td>
</tr>
<tr>
<td>Template</td>
<td>Choice list of templates that provide a predefined scale of options. For details, see Configure a template question. Multiple correct answers are supported.</td>
<td>Y</td>
</tr>
<tr>
<td>Reference</td>
<td>Choice list of fields from a specified reference table. This data type does not support reference qualifiers.</td>
<td></td>
</tr>
</tbody>
</table>
Questions tab

This tab displays all metrics added to the question bank for quizzes. Use the Filter field to search for questions. Each metric is displayed with its name and type.

Categories tab

This tab displays all metric categories added to the question bank for quizzes. All metrics in the question bank are group under the corresponding metric category. Use the Filter field to search for categories or questions.

Header Bar

The header bar contains tabs that display different views and a menu of various functions.

Click one of the following tabs to change the view in the canvas:

- **Design**: Add categories and questions, and configure the properties of each. This is the default view of the canvas when you open the designer.
- **Configuration**: Create introductions and end notes for quizzes, and select a signature.
- **Availability**: Select the recipients for each category in the quiz.

Point to the menu icon in the in the upper right of the quiz designer to select the following options:

- **Save**: Saves the current quiz.
- **Preview**: Displays a preview of the quiz as it appears to the recipients.
- **Publish**: Distributes the quiz to the selected recipients.
- **Save and Publish**: Saves and distributes the quiz in one step.
- **New Quiz**: Opens a fresh canvas for a new quiz.
- **Load Quiz**: Opens a list of existing quizzes that you can select and edit.
- **Copy Quiz**: Creates a copy of the quiz.

The availability of each option depends on the status of the quiz that is opened in the quiz designer.

Design Canvas

New quizzes open in the **Design** view. The quiz Name field appears above first category in the canvas. A blank question field appears in the category container.

Create a quiz

When you create a quiz, you can create one or more categories and then add questions to each category.

Role required: assessment_admin or admin

Each category can be assigned to a different user or the same users. You can also customize each question and make it dependent on the response to another question.

Create a quiz using these procedures:

*Create quiz categories*

A category represents a theme for evaluating a specific element of the quiz topic and contains questions pertaining to that theme.

Role required: assessment_admin or admin
When you create a quiz, the system creates a default category, using the name of the quiz. You can use this category, modify it, or create additional categories as needed. To have any results, a category must contain scored questions.

1. Navigate either Quizzes > Quiz Designer or Quizzes > Quizzes and click Quiz Designer in the list header.
2. Enter the name of the quiz in the Name field. The system uses this name as the name of the quiz and the first category
3. To configure the category, click the gear icon in its title bar.
   The Properties dialog box appears. You can change the name of the category, add a description for it, and enter text in the Details field that introduces or explains the category to the recipients. The system updates the category as you type.
4. Click the X icon to close the category properties dialog box and save your settings.

5. To add a new category, click the + icon in the title bar of an existing category.

Create quiz questions
You can create multiple questions for each category but each question can be associated with only one category.

Role required: assessment_admin or admin

The data type that you select for each question determines how it can be answered by quiz recipients. You can designate questions to be scored. Only scored questions are shown in the quiz results and considered when calculating the category results. You must also specify a correct answer for scored questions.
1. In the Design view, drag a data type icon from the Controls palette and drop it into a category container.
2. To configure the question, click in the gear icon in its title bar. The Properties dialog box appears for the question.

![Properties dialog box](image)

3. Fill in the fields on the form, as appropriate.

### Question property fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Required] Name of the question. Create a concise and easily recognizable name for your question. The system uses this value to identify the question in Assessment Metric lists and in scorecard charts.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to display as the question on quizzes. Enter a clear, straightforward question that is easy to understand.</td>
</tr>
<tr>
<td>Type</td>
<td>[Read-only] Data type selected for this question. See the table in Controls for possible data types.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this question is available on a quiz. If a question is marked inactive, it does not appear on quizzes generated after the question becomes inactive.</td>
</tr>
<tr>
<td>Boolean option</td>
<td>Whether a check box or a Yes/No list appears as the option for the Boolean question.</td>
</tr>
</tbody>
</table>
| Mandatory             | Check box for requiring users to answer the question. Users cannot submit quizzes until they answer all mandatory questions, which are denoted by a red field status indicator.  
                        | This field is available when the question does not have a dependency and the question Controls is not Boolean with a check box option.                                                                    |
| String option         | Setting for the appearance of a string field in a question. This field is available when the question type is String. The string options are:  
                        | • Single line: Single line text field 40 characters in length that allows strings of any length.  
                        | • String line wide: Full page width text field that allows a single line entry of any length.  
                        | • Multiline: Full page width multi-line text field that allows word wrap and returns.       |
| Min                   | Lowest positive whole number that users can enter or select to answer the question. This field is available when the question type is Number, Percentage, or Numeric Scale.                                    |
| Max                   | Highest positive whole number that users can enter or select to answer the question. This field is available when the question type is Number, Percentage, or Numeric Scale.                                    |
| Allow not applicable  | Check box for including Not Applicable as an option for this question. Users can select Not Applicable if they do not have sufficient information to respond to a question. User responses of Not Applicable are excluded from results calculations. This field is available when the question does not have a dependency and the question data type is not Boolean with a check box option. |
| Randomize answers     | Check box for displaying answer options in a random order whenever the question appears in a quiz. Answer preference is sometimes influenced by the order in which options appear, which can result in biased results. Randomizing options can help prevent this bias.  
                        | Note: Randomizing options for certain questions may make those questions confusing for users. In general, only randomize options that do not follow a logical order. |

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Information about the question that is displayed on the quiz. Include details that help users understand how to answer the question. You can also enter HTML text in this field with the WYSIWYG editor. For example, include HTML to embed links and images.</td>
</tr>
<tr>
<td>Correct answer</td>
<td>Answer option that you want to be selected by users. When you specify a correct answer for a question, the system scores the question. This field is available for all data types except Date, Date/Time, and String. Multiple correct answers are supported for a few data types. See data types.</td>
</tr>
<tr>
<td>Choices</td>
<td>Options for a question with a data type of Choice or Scale. The system automatically adds text and values that you can edit for each option. Click the + icon to add an option, or click the X icon to delete an option. By default, the system arranges options in the order established by their values. To change the order, drag and drop the options.</td>
</tr>
<tr>
<td>Dependency</td>
<td></td>
</tr>
<tr>
<td>Displayed when</td>
<td>Condition builder that hides or displays the question depending on the answer to another question in the same category. Select an existing question from the list with a data type of Boolean, Choice, Scale, or Template. Create the condition that must exist for recipients to see the dependent question, using the is or is one of operator. The system prevents recursive dependencies between questions. For example, if Question A depends on Question B, Question B cannot depend on Question A.</td>
</tr>
</tbody>
</table>

4. To create any special conditions that must be met for a question to appear on the quiz, click the Dependency tab. Fill in the fields, as appropriate. Dependent questions appear on the quiz when a recipient selects a specific answer or combination of answers to another question in the same category.

5. Select a question in the Displayed when field. The system selects the appropriate operator and displays the possible answers for the selected question.
6. Select the answers that satisfy the condition. Selected answers are indicated by a check mark.

7. Click X to close the question properties dialog box and save your settings.
8. To add a question with the same data type as an existing question in the category, click the + in the title bar of the existing question.
9. Drag questions to change their order within a category or move them between categories.
10. To delete a question, click the X in its title bar.

Configure a template question
You can configure template questions when designing quizzes.

Role required: assessment_admin or admin

1. Drag the Template data type icon into a category container.
2. Click the gear icon in the question title bar to open the template properties dialog box.
3. Select a predefined scale from the list.

Question entry fields appear for that template.
4. Enter one or more questions that are appropriate for the template.
5. Click the arrow to the right of a question to configure its properties. You must provide a name for each question.

6. Click the up or down arrow to move between questions, or click the back arrow to return to the template properties dialog box.

7. Configure the properties for the remaining questions.

8. Click the X icon to close the template properties dialog box and save your settings.

Configure a scored question

Only scored questions are considered when calculating category and quiz results.

Role required: assessment_admin or admin

A question must have a correct answer specified to be scored. Only results for scored questions are displayed in the quiz scorecard.

1. Navigate to Quizzes > Quizzes.
2. Open the quiz containing the questions you want to mark as scored.
3. In the Metric Categories related list on the Assessment Metric Type form, select the category for the questions you want to mark as scored.
4. In the Assessment Metrics related list on the Metric Category form, select a question from the list.
5. In the **Question Type** section of the **Assessment Metric** form, select the **Scored** check box.
   This check box is not available if the question's data type is not supported for scoring.

6. Select the **Correct answer** for the question.

   **Note:** Multiple correct answers are supported for a few data types. See [Data types for quizzes](#).

7. Click **Update**.

8. Repeat the process for all the questions in the category that you want the system to score.

9. Return to the list of metric categories, select another category, and configure scoring for the appropriate questions in that category.

**Configure a quiz**
You can configure an entire quiz.

**Role required:** assessment_admin, survey_creator, or admin

The values you enter and select on this page are applied to the entire quiz.

In the quiz designer, click **Configuration** and then fill in the fields as described in the table.

### Quiz designer configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box for enabling the distribution of this quiz to recipients.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of this configuration or the quiz to which it is attached.</td>
</tr>
<tr>
<td>Introduction</td>
<td>Introductory content to display on quizzes. You can add a welcome message or background information about the quiz.</td>
</tr>
<tr>
<td>Owners</td>
<td>Owners of the quiz. You can add a user with the survey_creator, survey_admin, or assessment_admin role.</td>
</tr>
<tr>
<td>Signature</td>
<td>[Optional] Acknowledgement by a quiz recipient of requirements, admonitions, or expectations related to a quiz.</td>
</tr>
<tr>
<td>Return URL</td>
<td>Destination address of a web page that is presented to users after they submit a completed quiz. When a return URL is configured, the <strong>End note</strong> content does not appear.</td>
</tr>
<tr>
<td>End note</td>
<td>Content that is displayed to recipients after they submit a completed quiz. You can add a thank you message, follow-up instructions, or other applicable information. End notes are not displayed if a <strong>Return URL</strong> is specified.</td>
</tr>
<tr>
<td>Duration</td>
<td>Amount of time that recipients are given to complete this quiz, starting from the time that the quiz is generated. The default duration is 14 days.</td>
</tr>
<tr>
<td>Manager</td>
<td>Assessment manager for this quiz. These users are only responsible for managing the quiz process and not the results. The system notifies the manager when submissions for this quiz are past due.</td>
</tr>
</tbody>
</table>
Select a quiz recipient

When the system distributes a quiz, it sends email notifications to the category users and their managers.

Role required: assessment_admin or admin

A category can have one or more assigned users, and the same user can be assigned to more than one category.

The system also creates a link to the quiz in the recipients’ My Assessments & Surveys portal. Users can only answer questions in the categories that they are assigned to.

To select the recipients for each quiz category, click Availability and then fill in the fields as described in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select category</td>
<td>Category for which the selected users are recipients.</td>
</tr>
<tr>
<td>Add users</td>
<td>Users selected as recipients for this category. The choice list shows all users in the system.</td>
</tr>
</tbody>
</table>

Publish a quiz

When you publish a quiz, the system sends email notifications to the recipients and to their managers. A card in each recipient’s My Assessments & Surveys portal displays a link to the quiz.

Role required: assessment_admin or admin

1. If you want to see the quiz as the recipients will see it, point to the menu icon in the upper right of the quiz designer and click Preview.
2. When you are satisfied with the quiz, click Save and Publish or Publish to distribute it.
Copy a quiz
Create a copy of a quiz with at least one category to reduce the effort of creating another quiz with similar data.

Role required: assessment_admin or admin

All associated questions (type), configurations, categories, metrics, domain separation rules, and role-based categories are copied. Assigned users, category users, instances, and trigger conditions are not copied.

1. Navigate to Quizzes > Quizzes.
2. Select a quiz.
3. Perform any of the following steps:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Platform</td>
<td>In the title bar, click <strong>Copy</strong>.</td>
</tr>
<tr>
<td>From Platform</td>
<td>In the title bar, select <strong>Copy</strong> from the context menu.</td>
</tr>
<tr>
<td>From quiz designer</td>
<td>a. In the title bar, click <strong>Quiz Designer</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. In the Quiz Designer title bar, point to the menu icon on the header bar and click <strong>Copy Quiz</strong></td>
</tr>
</tbody>
</table>

Edit a quiz
You can update a quiz after the quiz has been distributed.

Role required: assessment_admin or admin

You can only edit a quiz that has the same application scope as that of your current session.

- Questions that you add are available only on quizzes that are distributed after the update.
- Before a quiz is submitted or during the retake period:
  - Changes to existing questions are immediately available to users. This includes changes to the answers, such as additional choices or changes to the data type.
  - Deleted questions are deleted from distributed quizzes in users' queues.

Open the quiz: Group the Service Details form with one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes &gt; Quiz Designer</td>
<td>Point to the menu icon in the quiz header bar and select <strong>Load Quiz</strong>.</td>
</tr>
<tr>
<td>Quizzes &gt; Quizzes</td>
<td>Right-click a quiz in the list and select <strong>Quiz Designer</strong>.</td>
</tr>
<tr>
<td>Quizzes &gt; Quizzes</td>
<td>Open a quiz from the list and click <strong>Quiz Designer</strong> in the header of the Assessment Metric Type form.</td>
</tr>
</tbody>
</table>

Enable a quiz retake
You can configure a quiz to allow recipients to resubmit their answers as many times as they like, until the quiz's due date.

Role required: assessment_admin or admin
Results are not calculated until the quiz's configured duration has elapsed. The card in the user's queue remains visible until the quiz's due date and displays a button to allow retakes.

1. Navigate to **Assessments > Metric Definition > Types**.
2. Remove the **Evaluation method = Assessment** filter condition so you can see all the records in the list.
3. Open the quiz.
4. In the **Assessment Metric Type** form, select the **Allow retake** check box and save the record.

**View a quiz result**

You can view quiz results for each question and category, or view the quiz scorecard for a detailed breakdown.

Role required: assessment_admin or admin

Quiz results are stored in the Metric Result [asm_metric_result] table and display recipients' answers to each question in a category.

Navigate to **Quizzes > Quiz Results**.

![Quiz Results](image)

**View a quiz designer scorecard**

The quiz scorecard opens in the Category Results view.

For detailed information about scorecards, see Quiz Scorecards.

1. Navigate to **Quizzes > Quizzes**.
2. Open the quiz whose results you want to view.
3. Under **Related Links**, select **View Scorecard**.

The scorecard for the selected quiz opens in the Category Results view.
4. Select a category to view from the choice list above the chart.
Company Policies

Quiz Scorecard

Category Results

Dress Code

Dress Code

- Mens Trousers
- Shirts
- Shoes
- Skirt Length

- Casual Cotton
- Jeans
- Muscle-T
- N/A
- No
- Polo
- Yes

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
View a quiz category result

Category results are stored in the Assessment Category Result [asmt_category_result] table and display the overall ratings for each category based on the weighted value for each scored question.

1. To view category results, navigate to Quizzes > Category Results.

2. The system calculates results from the weight configured for each category. Weights are set to a value of 10 by default but can be changed. To edit a category's weight:

3. Navigate to Quizzes > Categories, and select a category from the list.
4. In the Metric Category form, edit the default value in the Weight field.
5. Click Update.

   Note: You can also edit the weight of a question in the Quiz view of the Assessment Metric form.

Take a quiz

All available quizzes assigned to you appear in your personal assessment and survey queue. When you submit a quiz, the system stores your responses. If a quiz allows retakes, you can resubmit it as many times as you like until its due date.

Role required: none

No special role is required to complete a quiz, but you must be logged in and the quiz must be assigned to you.

If configured to send email, the system sends you a notification when a quiz is assigned to you. The message contains a link to the quiz and instructions for viewing the assessment and survey queue.

Each quiz assigned to you appears in your assessment and survey queue as a card that contains information about the quiz, including a launch button. Overdue quizzes are marked with a red icon and red due date.

You must answer every required question, indicated by a red star, before you can submit the quiz. If you start to take a quiz but cannot complete it, save your responses and return to it later. When you have answered all the questions and are satisfied with the responses, submit the quiz.

By default, you cannot modify your answers to a quiz after submission. However, if the administrator has configured this quiz to allow retakes, the quiz remains in your queue after you finish it and the card shows a Modify Quiz button. You can retake the quiz as many times as you like before the due date.

1. Navigate to Self-Service > My Assessments & Surveys.
2. Click **Take Quiz** on a quiz card to open the questionnaire. If there is more than one quiz category, you can click the collapse or expand icon to hide or show the questions in the category.

3. Answer each question to the best of your ability. If you are unsure of how to respond to a question or if a question does not apply to you, select Not Applicable, if that choice is available.

4. Click **Save** at any time to save your responses without submitting them. You can reopen the quiz from your queue when you are ready to work on it again.

5. When you are ready to submit the completed quiz, read any assertions that require your attention.

6. If present, select the check box to acknowledge the assertion. If your full name is displayed, you are required to provide authentication to acknowledge the assertion after you submit the quiz.

7. Click **Submit**.

8. If prompted, enter your user name and password to verify your signature. If you provided valid answers for all mandatory questions, a success message appears, displaying any end note that was configured. If the quiz allows retakes, the card remains in your queue with a **Modify Quiz** button after submission. If retakes are not permitted, the card disappears from your queue.

9. If the system displays an error message indicating that a question has an invalid response or must still be answered, correct the error and resubmit the quiz.

10. To edit your answers and resubmit a quiz that permits retakes, click **Modify Quiz**. You can modify your responses to the quiz until its due date.

---

**View a quiz instance**

View an instance to verify that quiz instances were created, to check the state of a quiz instance, or to reassign a quiz instance. A quiz instance represents one questionnaire assigned to one user.

Role required: admin or assessment_admin

1. Navigate to **Quizzes > Quiz Instances**.

   The following submodules are available based on the state of the instances:
   - **Ready to take**: Displays quiz instances that the user can take. By default, these instances are sorted in ascending order by the **Number** field.
   - **In progress**: Displays quiz instances that are in progress. By default, these instances are sorted in ascending order by the **Number** field.
   - **Completed**: Displays quiz instances that are complete. By default, these instances are sorted in descending order by the **Taken on** field.
   - **Cancelled**: Displays quiz instances that are canceled. By default, these instances are sorted in ascending order by the **Number** field.
   - **All**: Displays quiz instances in all states. By default, these instances are sorted in ascending order by the **Number** field.

2. From the required submodule, click a quiz instance.

   **Note**: When you select an instance in the **Completed** submodule, you are redirected to the User's Response page.

3. In the form, fill the fields. By default, the following fields are displayed for all submodules other than the **Completed** submodule.

   **Quiz instance form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated record number.</td>
</tr>
<tr>
<td>Metric type</td>
<td>Metric type of this quiz.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Due Date</td>
<td>Date by which the quiz instance should be completed. The system populates the due date based on the <strong>Assessment duration</strong> of the associated quiz definition, which is set to 14 days by default. The quiz due date is not enforced in the base system. If you want to enforce the due date, consider using a workflow or other mechanism to send survey recipients reminders when a survey is overdue.</td>
</tr>
<tr>
<td><strong>Note:</strong> By default, the system runs the <strong>Cancel Expired Assessments</strong> script every 30 days to cancel expired survey, assessment, and quiz instances that are in the Work in progress or Ready to take states.</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>State of the quiz.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User that the quiz instance is assigned to. This field becomes read-only when the state is <strong>In progress</strong>, <strong>Complete</strong>, or <strong>Canceled</strong>.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain associated with the instance.</td>
</tr>
<tr>
<td>Related Link</td>
<td></td>
</tr>
<tr>
<td>View User's Response</td>
<td>Shows a read-only version of the survey responses completed by the user.</td>
</tr>
<tr>
<td>Related List</td>
<td>All instance question records that store user response values for each question on the quiz questionnaire. The following columns are relevant to quiz:</td>
</tr>
<tr>
<td>Assessment Instance Questions</td>
<td>• <strong>Category:</strong> Displays the quiz categories the questions belong to.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Metric:</strong> Displays the quiz questions.</td>
</tr>
</tbody>
</table>

**Quiz scorecards**

The Quizzes application prepares printable scorecards.

A scorecard analyzes category and question responses and compares current ratings with previous ratings. You can examine ratings over time, compare question ratings, or compare the ratings of all categories. All ratings are averages for the time range selected.

The system dynamically updates a scorecard each time you view it, so the ratings reflect recently completed quizzes.

**Category results**

The Category Results view is a stacked bar chart of responses to all questions in a category.

Select the category to display from the choice list above the chart. Category results are only calculated for scored questions.
This view displays responses that use the following data types:

- Checkbox
- Choice
- Likert Scale
- Number
- Template
- Yes/No

Note: The Checkbox and Yes/No data types are combined into the Boolean data type in the Quiz designer.
Quiz category results
To view details about a specific response to a question, point to the colored segment representing a specific response. The chart displays the count for those responses and the percentage it represents of the total responses to that question.

Quiz category result details

Question results

The Question Results view shows the results for all questions in a quiz. Select a question by name from the choice list to display the results in a pie chart or a bar chart, based on the data type.

Pie chart

The pie chart shows question results for these data types:

- Checkbox
- Choice
- Likert Scale
- Number
- Template
- Yes/No

Note: The Checkbox and Yes/No data types are combined into the Boolean data type in the Quiz designer.
Quiz scorecard question results - pie chart
Bar chart

A bar chart appears when question results use this data type:

- Percentage

By default, all results for percentage questions use a report range of 20% segments. To configure a report range, navigate to Reports > Administration > Report Ranges.

Average ratings

The Average Ratings view displays a bar chart of the weighted average rating for each question in a category.

Use this view to learn how individual questions affect the overall rating for the category. Select a category from the second choice list above the chart. Ratings are only calculated for scored questions.
Average Ratings view

To view the effect of each question's ratings on the entire category's ratings, point to the colored bar. The pop-up box shows the percentage of the total ratings represented by each individual question's weighted average.
Quiz scorecard rating detail

Quiz reports

Quizzes provide several global reports so that assessment administrators can view important statistics. You can share these reports with specific users or groups and change the display options.

For detailed field information and reporting options, click the link for the chart **Type.** To sort a column in ascending or descending order, click the arrow in the column heading.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quizzes by State</td>
<td>State of distributed quizzes. This chart displays the percentage of distributed quizzes that are ready to take, in progress, complete, or canceled.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Pie Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Assessment Instance [asmt_assessment_instance]</td>
</tr>
<tr>
<td>Total Questions by Quiz</td>
<td>Total number of questions for all categories in each quiz.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Questions by Data Type</td>
<td>Total number of questions in all quizzes by data type.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Correct Answers by Assigned User</td>
<td>Total number of scored questions answered correctly by each assigned user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Number of Correct Answers</td>
<td>Total number of correct answers for each scored question.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table:</strong> Metric Results [asmt_metric_result]</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incorrect Answers by Assigned User</td>
<td>Total number of scored questions answered incorrectly by each assigned user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
</tr>
<tr>
<td>Number of Incorrect Answers</td>
<td>Total number of incorrect answers for each scored question.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Bar Chart</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong>: Metric Results [asmt_metric_result]</td>
</tr>
</tbody>
</table>

### Wizards

The Wizards functionality, which enabled administrators to create wizards that provide a step-by-step sequence of dialog boxes that lead the user through a procedure, was deprecated in the Eureka release. However, some users are still able to access this functionality if they enabled its plugin in previous releases.

For more information about this functionality, see [https://docs.servicenow.com/bundle/archive/page/archive/fuji-archive.html](https://docs.servicenow.com/bundle/archive/page/archive/fuji-archive.html).

### Service Portal

Service Portal is a portal framework that allows administrators to build a mobile-friendly self service experience for users. It interacts with parts of the ServiceNow platform, so users can access specific platform features using Service Portal. It is an alternative to the Content Management System (CMS) based on more modern technologies.

Both expert developers and beginners can configure Service Portal.

Less technical users can make basic configuration changes to the UI using Branding Editor and other components of Service Portal. More advanced users can edit and extend portals, pages, and widgets. Expert users can use the Widget Editor tool to write scripts to power a portal, and even create rich web applications on the Now Platform.

**Explore**
- Upgrade to New York
- Understanding Service Portal
- Service Portal core concepts
- Service Portal training on the ServiceNow® Developer Site
- Domain separation in Service Portal

**Set up**
- Set up Service Portal
- Service Portal search
- Configure a portal header menu
- Content Management and Service Portal

**Administer**
- Single sign-on, logins, and URL redirects
- Service Portal security
- Automated test framework for Service Portal forms
- Automated Test Framework for Service Catalog in Service Portal
- Activate guided tours for Service Portal

**Use**
- Service Portal pages
- Widget library

**Develop**
- Widget developer guide
- Widget developer training

**Troubleshoot and get help**
- Ask or answer questions in the Service Portal forum

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Understanding Service Portal

Service Portal provides a modular user interface framework for quick and easy building of application portals and dashboards for the platform. It helps developers and non-technical administrators create attractive and engaging user experiences that drive employee adoption of critical enterprise applications.

How do you use Service Portal?

Service Portal is an application included in the platform UI, however it includes a visual layer for you to do most of your configuration. In the application navigator, navigate to Service Portal > Service Portal configuration to view the configuration page.

The Service Portal configuration page provides a unique, intuitive way of viewing all the pieces of your portal and how they interact with one another. The configuration page allows you to take advantage of a real-time preview, while configuring portal settings. Use each of the tiles on the configuration homepage to assemble the different components of your portal.

If you prefer the platform layout for configuring Service Portal, you still have the option of creating your portal components within the platform UI. The two options are not separate. Everything you create in the Service Portal configuration page also appears in a table in the platform UI.

Watch this five-minute video for an introduction to the Service Portal user interface, guided tours of the Service Portal, using the Service Portal, chat support, and Virtual Agent.

Who uses Service Portal?

Several different kinds of users can configure a portal.

- Limited coding: Service Portal was designed so that even users with limited coding ability or knowledge of the platform UI could set up a portal.
- ServiceNow Experts: Users with an understanding of the ServiceNow platform can create portals, set up URL redirects, and view all the components of the portal in a table. Most portal configuration takes place in the Service Portal configuration page, but in specific circumstances, Service Portal administrators may need to do additional configuration directly within the platform.
- Developers: Advanced customizations and new widget creation are tasks for a developer or someone who understands AngularJS and Twitter bootstrap.

In all cases, the user configuring a portal must have the admin or sp_admin role.

Basic concepts

You should have a basic understanding of all the following components that make up a portal:

- Themes: Themes define the look and feel of the whole portal, but can be overridden by other style configurations.
- Pages: Pages control where and how you store portal content. Pages do not have a defined relationship to portal records, they simply exist.
• **Widgets**: Components in Service Portal are called widgets. You can use HTML templates, CSS, client scripts, server scripts, and any JavaScript dependencies to define what a widget does. From an AngularJS standpoint, widgets are essentially a superset of an Angular directive.

• Most of the data in Service Portal is managed in different locations throughout the system.

For example, if you are building a knowledge portal, the data exists in Service Portal, but the knowledge articles are authored and managed in the Knowledge application. The same is true for any other type of content you plan to leverage. Take time to understand which tables contain and control the data you are working with in Service Portal.

### Additional resources

Service Portal is built using several well known technologies. Use the following websites as resources to help you understand and configure your portal:

- Twitter Bootstrap
- CSS 3 Flexbox
- AngularJS

### Service Portal core concepts

Service Portal contains two parts: a framework and a portal. The framework is composed of a set of APIs, Angular services, directives, and tools that help to build portals. The portal is a group of pages linked by page IDs.
After you enter a URL, the framework uses the suffix and picks the appropriate portal to determine the theme and configurations. Then it loads the configured default portal homepage unless the URL has a specified ID.

Each widget added to a page becomes its own instance. A widget instance is basically the application of a widget in a page. Because widgets are reusable and can appear on different pages to do different things, the manifestation of a widget on a page is referred to as a Widget Instance. The page loads with content represented by widgets.

Widget instances get their logic from the base widget template, client scripts, server scripts, and depending on the widget, CSS.
Activate Service Portal

If Service Portal is not active on your instance, you can activate it from the plugin module. You must have the administrator role to activate a plugin.

Locate the Service Portal for Enterprise Service Management [com.glide.service-portal.esm] plugin in the list of plugins. Activate the plugin and select the option to include demo data. For more information on activating a plugin, see the #unique_7 topic.

Activating Service Portal automatically activates the following plugins:

- Service Portal - Knowledge Base [com.glide.service-portal.knowledge-base]
- Service Portal - Service Catalog [com.glide.service-portal.service-catalog]
- Service Portal - Service Status [com.glide.service-portal.service-status]
- Service Portal Configuration Pages [com.glide.service-portal.config]
- Service Portal Designer [com.glide.service-portal.designer]
- Service Portal Social QA [com.glide.service-portal.sqanda]
- Service Portal Surveys [com.glide.service-portal.survey]

Content Management and Service Portal

Service Portal is a compelling alternative to the Content Management System (CMS) with a refined user experience. It does not duplicate CMS or platform UI functionality. Users who have sophisticated experiences delivered through CMS may need to invest time into transitioning to Service Portal, especially if the CMS implementation includes complex and customized Service Catalog forms.

Service Portal compatibility with existing CMS sites

ServiceNow continues to support CMS in current and upcoming releases. If you have existing CMS sites and activate Service Portal on your instance, your CMS sites will continue to work, as CMS and Service Portal are separate applications.

Differences between Service Portal and CMS

Service Portal is an alternative to CMS based on more modern technologies. Major differences include:

Underlying technology

CMS uses Jelly, which is not a widely used technology. Service Portal instead uses AngularJS, server-side JavaScript, HTML, and CSS. Any scripts that use Jelly do not work in Service Portal. Building widgets in Service Portal requires knowledge of AngularJS.

Visual layer

CMS uses iFrames which can be difficult to work with, limited in terms of styling, and susceptible to upgrade issues. Alternatively, Service Portal is a self-contained application that accesses data from other tables on the platform. This enables fine-tuned control over style and responsive design.

Mobile first

Unlike CMS, Service Portal is optimized for a mobile environment. For this reason, the following apply to the Service Portal environment:

- Any scripts used in Service Portal can only use APIs supported in a mobile environment. For example, some APIs used in your Service Catalog client scripts may not be supported. For a list of supported APIs, see Service Portal and client scripts.
• Service Portal forms support a maximum of two-columns. As a result, any highly customized Service Catalog forms, such as catalog items and record producers that use containers and variable sets, must be simplified to work in a two-column layout.

If transitioning to Service Portal, review the following resource: #unique_2778.

To understand how core CMS components are configured in Service Portal, refer to the following table.

**CMS and Service Portal components**

<table>
<thead>
<tr>
<th>CMS component</th>
<th>Service Portal equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content site</td>
<td>Portal</td>
</tr>
<tr>
<td>Content page</td>
<td>Page</td>
</tr>
<tr>
<td>Content types</td>
<td>Content types link a table to a content page.</td>
</tr>
<tr>
<td></td>
<td>In Service Portal, content types are no longer required. Record data is queried and displayed using base system widgets. You can add widgets to any number of Service Portal pages.</td>
</tr>
<tr>
<td></td>
<td>Learn more: Service Portal widgets.</td>
</tr>
<tr>
<td>Layout and dropzones</td>
<td>In Service Portal, pages are made up of containers, rows, and columns.</td>
</tr>
<tr>
<td></td>
<td>Learn more: Pages.</td>
</tr>
<tr>
<td>Content block</td>
<td>A content block is a reusable piece of content.</td>
</tr>
<tr>
<td></td>
<td>In Service Portal, content blocks are replaced by widgets.</td>
</tr>
<tr>
<td></td>
<td>Learn more: Service Portal widgets.</td>
</tr>
<tr>
<td>Service Catalog</td>
<td>Service Catalog pages are rendered using the SC Catalog Item widget in Service Portal. For this reason, Service Catalog forms such as catalog items and record producers are shared between your CMS implementation and Service Portal. If you have a highly customized Service Catalog, you may need to invest time in simplifying your Service Catalog items and client scripts so that they render as expected in Service Portal.</td>
</tr>
<tr>
<td></td>
<td>Learn more: Service Catalog forms in Service Portal.</td>
</tr>
<tr>
<td>Theme</td>
<td>Theme</td>
</tr>
<tr>
<td>CSS</td>
<td>CSS</td>
</tr>
</tbody>
</table>

**CMS and Service Catalog customizations**

Service Portal comes with base system widgets to address common use cases and to display record data. Even though there is no direct migration path from CMS to Service Portal, there may be some items, such as catalog items or knowledge articles, that render as expected in Service Portal without any effort.

However, because Service Portal is supported in a mobile environment, you may need to modify any customized forms and scripts. This approach ensures that the items display well on a mobile device and present a better user experience. Before transitioning to Service Portal, you may need to:

• Refactor client scripts used in your CMS/Service Catalog to use supported mobile APIs and global objects. For a list of supported APIs, see Service Portal and client scripts.
• Build widgets to replace UI Macros and other unsupported scripts. If using a UI Macro in a catalog item form and referencing values on the form, you can use the following workaround instead: Replace a Service Catalog form script with a widget.
• Simplify any complex forms used in your Service Catalog to fit the Service Portal two-column form layout.
• Consider which release supports the required functionality. You may want to upgrade your instance before transitioning to ensure that you have the required base system features.

**CMS to Service Portal transition**

Your CMS may include complex forms and customizations that do not render as expected in Service Portal. Use this guide to understand how best to modify your CMS and Service Catalog implementation for Service Portal adoption, and to understand how a conversion may affect your users.

If you are considering transitioning from CMS to Service Portal, make sure that you understand the impact of moving to a mobile environment. Review the #unique_2778.

**Support level and transition actions**

<table>
<thead>
<tr>
<th>CMS component</th>
<th>Service Portal support</th>
<th>Possible transition actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data lookups</td>
<td>The client-side component of a data lookup is not supported in Service Portal. However, the data lookup is applied in the platform when a record is submitted or updated in Service Portal.</td>
<td>While data lookups are not applied in the Service Portal, the record updates as expected in the platform UI when submitted or updated in the Service Portal. If your CMS is used by requesters only, this limitation may not affect your implementation.</td>
</tr>
<tr>
<td>Content blocks</td>
<td>Because Content blocks use Jelly, they are not supported in Service Portal.</td>
<td>In the Service Portal, content blocks are replaced by widgets. Widgets are highly customizable components that can query record data, display and update records, and gather user input. Base system widgets generally cover most use cases. Just as you add content blocks to a page in your CMS, you can add widgets to a page using the Service Portal Designer.</td>
</tr>
<tr>
<td>UI Macros</td>
<td>Because UI Macros use Jelly, they are not supported in Service Portal.</td>
<td>• In Service Portal, you can use widgets instead of UI Macros. Base system widgets generally cover most use cases, but for custom solutions, you can develop new widgets using AngularJS. • If your implementation includes UI Macros in Service Catalog forms that reference other fields or variables in the form, you can embed the widget inside a Service Catalog variable. Learn more: Replace a Service Catalog form script with a widget.</td>
</tr>
<tr>
<td>CMS component</td>
<td>Service Portal support</td>
<td>Possible transition actions</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>UI actions</td>
<td>All server-side UI actions are supported in Service Portal, although <code>setRedirectURL()</code> operations are ignored because Service Portal forms handle redirection in a different way than the platform. The form widget ignores all UI actions marked as Client.</td>
<td>• Refactor any UI actions to remove <code>setRedirectURL()</code> operations. • Check that UI actions are not marked as client.</td>
</tr>
<tr>
<td>Catalog client scripts</td>
<td>Only UI Type options Mobile / Service Portal and All are supported. UI type Desktop is not supported in Service Portal. For a list of supported APIs, see Service Portal and client scripts.</td>
<td>• Update your scripts to remove any unsupported client APIs. • Check that the script UI Type is set to Mobile / Service Portal or All.</td>
</tr>
<tr>
<td>UI policies</td>
<td>Scripted UI policies can only use APIs supported in Service Portal. For a list of supported APIs, see Service Portal and client scripts.</td>
<td>Update your scripts to remove any unsupported client APIs.</td>
</tr>
<tr>
<td>CMS component</td>
<td>Service Portal support</td>
<td>Possible transition actions</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------</td>
<td>-----------------------------</td>
</tr>
</tbody>
</table>
| Service Catalog variables | Service Catalog variables are supported in Service Portal with the following exceptions:  
  • UI Macros and UI pages variable types are not supported.  
  • Validation Scripts for variables are not supported. Supported validation types include:  
    • The Mandatory field on the variable form.  
    • Read-only variables.  
    • All fields in the Availability tab of the variable form.  
  • Default variable size is not supported.  
  • Expanding and collapsing help text is not supported. Rather, the Help text and Instructions fields defined in the Annotations tab on the variable form are always expanded. The Help tag does not display.  
  • The List Collector variable displays as a choice list instead of a slushbucket in the Service Portal. | • If embedding a widget in a catalog item form, you can use the UI Macro variable type. Learn more: Replace a Service Catalog form script with a widget.  
• If using variable with annotations, make sure to test your catalog items in Service Portal to ensure that help text displays as expected. |
| Order guides | Order Guides in Service Portal use the Order Guide widget. | Large order guides can cause performance issues in the Service Portal. If you have large order guides, you can:  
• Break them into multiple order guides.  
• Simplify variables used in the order guides.  
• As a temporary solution, you can render the Service Catalog item using an iFrame. See Service Catalog forms in Service Portal. |
| Record producers | Record producers are used in Service Portal with the following differences:  
  • The sort order for catalog items in record producers is not honored.  
  • Date values do not honor time zone when the record producer submits a record. | Make sure to test all record producers used in Service Portal to make sure that they behave as expected. |
| Login scenarios and redirects | In CMS, you used the CMSEntryPage script include to define login scenarios. Instead, Service Portal uses the SPEntryPage script include and related system properties to define login scenarios. Redirects are not supported in Service Portal. | In Service Portal, define login behavior by modifying the SPEntryPage script include and setting system properties.  
For more information, see Single sign-on, logins, and URL redirects. |
<table>
<thead>
<tr>
<th>CMS component</th>
<th>Service Portal support</th>
<th>Possible transition actions</th>
</tr>
</thead>
</table>
| Service Catalog forms  | Service Catalog forms such as catalog items and record producers are rendered within widgets in a two-column layout. Complex forms may not display as expected.  
• Only the top-level container settings are honored. If there are other containers within the top-level container, they are rendered as a single column. If there are container splits or nested containers within these additional containers, they are rendered as a single column. A top-level container is not a child of any other container.  
• There can be a maximum of two columns in Service Portal. If your implementation includes forms with more than two columns, the fields are reorganized into two-columns in Service Portal.  
• Variable sets are treated as containers. All previously listed rules apply to variable sets as well as any containers within them.  
• Default variable size is not supported in Service Portal. | • Simplify any complex forms in your Service Catalog.  
• As a temporary solution, you can render the Service Catalog item using an iFrame. See Service Catalog forms in Service Portal. |
| Shopping cart          | The Service Portal includes a base system Shopping Cart widget.                        | Use the Shopping Cart widget.                                                               |

### Service Catalog forms in Service Portal

Service Catalog forms are rendered within Service Portal widgets in a two-column layout. Complex forms may not display as expected.

### Recommendations when creating Service Catalog forms

Use the following recommendations as a guide to building scalable forms that can be used in both applications:

• Keep forms simple. Because forms with multiple containers, variable sets, and client scripts do not always display as expected in Service Portal, keep forms short to eliminate conversion and debugging issues.

• Think in mobile. Any support for Catalog Client Scripts or Catalog UI Policies is the same as in mobile. Review the following resource: #unique_2778.

### Form rendering in Service Portal

Containers and variable sets within Service Catalog forms are translated into a two-column layout when implemented in Service Portal. Service Catalog forms are rendered in Service Portal using the following rules:
• Only the top-level container settings are honored. If there are other containers within the top-level container, they are rendered as a single column. If there are container splits or nested containers within these additional containers, they are rendered as a single column. A top-level container is not a child of any other container.
• There can be a maximum of two columns in Service Portal. If your implementation includes forms with more than two columns, the fields are reorganized into two-columns in Service Portal.
• Variable sets are treated as containers. All previously listed rules apply to variable sets as well as any containers within them.
• Default variable size is not supported in Service Portal.

For other forms in the platform, the view determines how the form displays in Service Portal. For base system tables, the form opens in the Service Portal using the Service Portal table form view.

**Example layout conversions**

The following examples demonstrate how Service Catalog forms display in Service Portal.

**Single-column form**

A Service Catalog form with:

• Two containers.
• A single-column layout.
In Service Portal, the single-column layout renders as expected.
Two-column layout with subcontainers

A Service Catalog form with:

- A container with a two-column layout.
- A subcontainer with a single-column layout.
- A subcontainer with a two-column layout.
Service Catalog form

In Service Portal, the two-column layout setting of the subcontainer is ignored. The subcontainer renders as a single column.
Service Portal result

Two-column layout with variable sets and subcontainers

A Service Catalog form with:

- Containers with single-column and two-column layouts.
- Variable sets with a two-column layout within containers.
Service Catalog form

In Service Portal, the two-column layout settings of the variable sets are ignored when inside a container column.
<table>
<thead>
<tr>
<th>Container1</th>
<th>Variable1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>VariableSet1</td>
<td>Variable5</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Variable6</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Variable2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Container2</td>
<td>Variable3</td>
</tr>
<tr>
<td>VariableSet2</td>
<td>VariableSet2</td>
</tr>
<tr>
<td>Variable7</td>
<td></td>
</tr>
<tr>
<td>VariableSet3</td>
<td>Variable9</td>
</tr>
<tr>
<td>Variable8</td>
<td></td>
</tr>
<tr>
<td>Variable10</td>
<td>Variable4</td>
</tr>
</tbody>
</table>
Containers within variable sets

A Service Catalog form with:

- Variable sets with single-column layouts.
- A container with a single-column layout with a container split within a single-column variable set.
- A container with a two-column layout within a single-column variable set.

Service Catalog form

In Service Portal, the container split and two-column container settings are ignored when inside a single-column variable set.
<table>
<thead>
<tr>
<th>Variable1</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>VariableSet1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Container1</td>
</tr>
<tr>
<td>Variable2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variable3</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Variable4</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>VariableSet2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Container1</td>
</tr>
<tr>
<td>Variable5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variable6</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Variable7</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Variable8</th>
</tr>
</thead>
</table>
Nested containers

A Service Catalog form with:

- Containers that contain variable sets.
- Variable sets that contain nested containers.

Service Catalog form

In Service Portal, nested container formatting is ignored and displays as a single-column.
<table>
<thead>
<tr>
<th>Container1</th>
<th>VariableSet1</th>
<th>VariableSet2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Container2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Variable1</td>
<td></td>
<td>NestedVariable5</td>
</tr>
<tr>
<td>Variable2</td>
<td></td>
<td>NestedVariable6</td>
</tr>
<tr>
<td>Variable3</td>
<td></td>
<td>NestedVariable7</td>
</tr>
<tr>
<td>Variable4</td>
<td></td>
<td>NestedContainer2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NestedVariable8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NestedVariable9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NestedVariable10</td>
</tr>
</tbody>
</table>

Service Portal result
Render a complex form in Service Portal using an iFrame

Because complex forms do not display as expected in Service Portal, you can render catalog items, record producers, and order guides in Service Portal using an iFrame. This workaround is a temporary solution to enable your Service Portal to function as expected while you simplify any complex Service Catalog forms.

When rendering items in an iFrame in Service Portal, the following limitations apply:

- On catalog items and record producers, the attachment icon is not visible. As a result, users cannot attach any files during the submission. As a workaround, you can add the attachment button to your form.
- Click-through for the hover-over icon is not available.
- Forms are not optimized for a mobile environment.

Use the attached resources and follow the instructions detailed in the Community post: Service Catalog on Service Portal.

**Note:** Be sure to make changes in a test environment before updating your production instance.

Replace a Service Catalog form script with a widget

You can use widgets in Service Portal to replace UI Macros. If your Service Catalog form includes a UI Macro that references other fields or variables on the form, you can create a widget to hold reusable code and embed it within the Service Catalog form. Use special syntax to access any variable fields on the form.

Role required: admin or sp_admin

1. Create a widget that performs the action you would like to use in catalog item forms. See step 7 for a simple example widget that accesses another variable on the form.
2. Open a catalog item that previously used a UI Macro or other reusable component not supported in Service Portal.
3. In related lists, add a new variable to the catalog item.
4. Configure the variable form to add the **Widget** field.
5. In the **Type** field, select **Macro**.
6. In the **Widget** field, select a widget that performs the desired action.
7. Optional: Use the `$scope.page.g_form()` or `$scope.page.field` syntax in the embedded widget to access the catalog item values.
   This example shows how to modify the value of a single-line text variable with the name `color` associated with the catalog item.

**Widget HTML Template**

```html
<div>
    Data from catalog variable:
    <h1>{{ c.data.message }}</h1>
</div>
```

**Widget client script**

```javascript
function($scope) {
    var c = this;

    //Watch for changes in the color variable
    $scope.$watch(Function() {
        return $scope.page.g_form.getValue('color');
    }, function (value) {
```
//Update local data object with data from variable
c.data.message = value ? 'Content of color variable: ' + value : '';
});
}

You can use the following to access variable or catalog item fields:

- `$scope.page.g_form()`: The g_form instance on the form. You can use all supported g_form methods described in Service Portal and client scripts. For example, `g_form.setValue('variable_name', 'new value');`.
- `$scope.page.field()`: The object that represents the variable.

When you open the catalog item in the Service Portal, the embedded widget accesses the variable fields associated with the catalog item.

What color would you like?

Blue

Data from catalog variable:

**Content of color variable: Blue**

**Supported features in Service Portal**

Service Portal is an alternative presentation layer for the platform. As such, not all features of the platform are extended to Service Portal. Consider your full application and the abilities of Service Portal before making considerable investments.

**Not currently supported**

- Domain separation at Levels 1-3. However, Service Portal does include support for domain separation at the **Data only** level. For more information, see Application support for domain separation and Domain separation in Service Portal.

**No plans to support**

- @ Mentions
- Click-through/pop-ups
- Embedded HTML outside of HTML fields
• Embedded lists
• UI macros
• Formatters
• UI actions marked as Client
• Nested container Catalog variables
• Survey wizards
• OpenFrame

Service Portal and client scripts

You can use client scripts and catalog client scripts in the Service Portal if the UI Type is set to Mobile / Service Portal or All. Client scripts and catalog client scripts are used with the Form widget and SC Catalog Item widget, as opposed to a widget client controller.

Before flagging a script as Mobile/Service Portal or All, make sure that you are only using the mobile APIs. Setting a client script to Mobile does not ensure that it will work, it simply flags that the script should be attempted by the mobile app or the Service Portal. Many of your existing client scripts can be set to All as long as the API calls are supported by the mobile client scripting environment.

The topics in this section require advanced coding knowledge and an understanding of Service Portal APIs.

Checking desktop vs mobile runtime

You might want to mark a client script compatible with both desktop and mobile, but include behavior that depends on the runtime. You can use this script:

```javascript
if (window === null)
    // Write your mobile compatible code here
else
    // Write your desktop compatible code here
```

Unsupported client scripting globals

Widget client controllers are full Angular controllers and are not subject to the unsupported client script globals listed here. Use jQuery and Angular as needed.

The following globals and APIs are unavailable in client scripts and catalog client scripts used in the Service Portal:

- $    
- $$
- $j
- angular
- control
- document
- jQuery
- window
Embedded widgets & g_form

When using the Service Catalog variable type Macro and Macro with Label, you can pick a widget to embed in a catalog item form. Within the client controller for the embedded widget you can access the field object and catalog item g_form instance using:

- $scope.page.field
- $scope.page.g_form()

Client scripts used with Service Portal

The g_list global helps you set the filter of a Glide list element or a list collector variable. Use this API in place of the g_filter API on desktop client scripts.

```javascript
function onLoad() {
    var myListCollector = g_list.get("my_list_collector");
    myListCollector.reset();
    myListCollector.setQuery("active=true^category=8c7b22230b402200b0b2c6317673a62");
    myListCollector.addItem('3a700d39af5f4f0caab978df9df4cd692', 'Power Supply');
    myListCollector.addItem('1cb93419a3a248328daa8f91410b42f6', 'Backpack');
}
```

g_service_catalog is only available in Service Portal service catalog item scripts. Use this API to know if your catalog item script is run as part of an order guide or on its own.

```javascript
function onLoad() {
    if (window) // if CMS, don't run this return;
    // g_service_catalog api for Service Portal and Mobile
    var isOrderGuide = g_service_catalog.isOrderGuide();
    g_form.setValue("is_order_guide", isOrderGuide ? "Yes!" : "Nope :(");
}
```

Supported client script types and APIs

Some client scripts are not supported in Service Portal. Others must have a UI type set to All or Mobile / Service Portal. If using a client script in the Service Portal, only client-side APIs supported in a mobile environment can be used.

Client script support in Service Portal

<table>
<thead>
<tr>
<th>Client script</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog client scripts</td>
<td>Service Portal requires that the UI Type field be set to All or Mobile / Service Portal. Client Scripts marked as Desktop rely on legacy APIs that are not supported in Service Portal. Before flagging a script as Mobile / Service Portal or All, make sure you are only using supported client-side APIs.</td>
</tr>
<tr>
<td>Client script</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Validation scripts</td>
<td>Service Portal requires that the <strong>UI Type</strong> field be set to <strong>All</strong> or <strong>Mobile / Service Portal</strong>. Client Scripts marked as <strong>Desktop</strong> rely on legacy APIs that are not supported in Service Portal. Before flagging a script as Mobile / Service Portal or All, make sure you are only using supported client-side APIs. Validate user input in a specific field type using a validation script. In new instances, Service Portal includes XML, Script, Script (Plain), Email, and Version validation scripts by default. If upgrading from a previous release, the Mobile and Service Portal version is not active by default. You must activate the Mobile and Service Portal version of the validation script to validate user input in the Service Portal. See <a href="#">Activate Service Portal validation scripts</a>. <strong>Note:</strong> To call a UI script within a Validation script, use the <code>g_ui_scripts</code> global object. For more information, see <a href="#">GlideUIScripts</a>. Verify that the UI script has the <strong>Global</strong> field set to false and <strong>UI Type</strong> set to Mobile / Service Portal or All.</td>
</tr>
<tr>
<td>UI scripts</td>
<td>Service Portal requires that the <strong>UI Type</strong> field be set to <strong>All</strong> or <strong>Mobile / Service Portal</strong>. Client Scripts marked as <strong>Desktop</strong> rely on legacy APIs that are not supported in Service Portal. Before flagging a script as Mobile / Service Portal or All, make sure you are only using supported client-side APIs.</td>
</tr>
<tr>
<td>UI Actions</td>
<td>All server-side UI actions are supported in Service Portal, although <code>setRedirectURL()</code> operations are ignored because Service Portal forms handle redirection in a different way than the platform. The form widget ignores any UI Actions marked as <strong>Client</strong>.</td>
</tr>
<tr>
<td>UI Policies</td>
<td>Supported, although you should use only declarative UI Policies. Avoid scripting unless the outcome cannot be achieved through the condition builder.</td>
</tr>
<tr>
<td>UI Macros</td>
<td>Not supported as UI macros use Jelly.</td>
</tr>
<tr>
<td>Formatters</td>
<td>Not supported as formatters use Jelly.</td>
</tr>
</tbody>
</table>

**Supported client-side APIs**

Supported client scripting APIs for use in `onLoad`, `onChange`, and `onSubmit` client scripts.

For detailed class and method information, see the API reference.
### Available methods

<table>
<thead>
<tr>
<th>Class</th>
<th>Methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>g_form</td>
<td>• addDecoration(fieldName, icon, title)</td>
</tr>
<tr>
<td></td>
<td>• addErrorMessage(message)</td>
</tr>
<tr>
<td></td>
<td>• addInfoMessage(message)</td>
</tr>
<tr>
<td></td>
<td>• addOption(fieldName, value, label, index)</td>
</tr>
<tr>
<td></td>
<td>• clearOptions(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• getActionName()</td>
</tr>
<tr>
<td></td>
<td>• getBooleanValue(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• getDecimalValue(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• getEncodedRecord()</td>
</tr>
<tr>
<td></td>
<td>• getFieldNames()</td>
</tr>
<tr>
<td></td>
<td>• getIntValue(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• getLabel(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• getReference(fieldName, callback)</td>
</tr>
<tr>
<td></td>
<td>• getRelatedListNames()</td>
</tr>
<tr>
<td></td>
<td>• getSectionNames()</td>
</tr>
<tr>
<td></td>
<td>• getSysId()</td>
</tr>
<tr>
<td></td>
<td>• getValue(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• hasField(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• hideAllFieldMsgs(type: &quot;info</td>
</tr>
<tr>
<td></td>
<td>• hideErrorBox(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• hideFieldMsg(fieldName, clearAll)</td>
</tr>
<tr>
<td></td>
<td>• hideRelatedList(listTableName)</td>
</tr>
<tr>
<td></td>
<td>• hideRelatedLists()</td>
</tr>
<tr>
<td></td>
<td>• isMandatory(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• isNewRecord()</td>
</tr>
<tr>
<td></td>
<td>• isReadOnly(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• isVisible(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• removeDecoration(fieldName, icon, title)</td>
</tr>
<tr>
<td></td>
<td>• removeOption(fieldName, value)</td>
</tr>
<tr>
<td></td>
<td>• save()</td>
</tr>
<tr>
<td></td>
<td>• serialize(onlyDirtyFields)</td>
</tr>
<tr>
<td></td>
<td>• setFieldPlaceholder(fieldName, placeholder)</td>
</tr>
<tr>
<td></td>
<td>• setLabel(fieldName, label)</td>
</tr>
<tr>
<td></td>
<td>• setMandatory(fieldName, isMandatory)</td>
</tr>
<tr>
<td></td>
<td>• setReadOnly(fieldName, isReadOnly)</td>
</tr>
<tr>
<td></td>
<td>• setSectionDisplay(sectionName, isVisible)</td>
</tr>
<tr>
<td></td>
<td>• setValue(fieldName, value, displayValue)</td>
</tr>
<tr>
<td></td>
<td>• setVisible(fieldName, isVisible)</td>
</tr>
<tr>
<td></td>
<td>• showErrorBox(fieldName, message, scrollForm)</td>
</tr>
<tr>
<td></td>
<td>• showFieldMsg(fieldName, message, type: &quot;info</td>
</tr>
<tr>
<td></td>
<td>• showRelatedList(relatedTableName)</td>
</tr>
<tr>
<td></td>
<td>• showRelatedLists()</td>
</tr>
<tr>
<td></td>
<td>• submit(submitActionName)</td>
</tr>
</tbody>
</table>

**Note:** Using the `variables.var_name` notation with the `g_form` API is not supported in Service Portal. `g_form` as a global object cannot be used in a widget client controller or in a UI script.
<table>
<thead>
<tr>
<th>Class</th>
<th>Available methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>g_list</td>
<td>• get(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• addItem(value, displayValue)</td>
</tr>
<tr>
<td></td>
<td>• removeItem(value)</td>
</tr>
<tr>
<td></td>
<td>• reset()</td>
</tr>
<tr>
<td></td>
<td>• setQuery(queryString)</td>
</tr>
<tr>
<td></td>
<td>• setDefaultOperator(operator)</td>
</tr>
<tr>
<td></td>
<td>• get_default()</td>
</tr>
<tr>
<td>g_service_catalog</td>
<td>isOrderGuide()</td>
</tr>
<tr>
<td>GlideAjax</td>
<td>• addParam (name, value)</td>
</tr>
<tr>
<td></td>
<td>• getParam (name)</td>
</tr>
<tr>
<td></td>
<td>• getXML(callback)</td>
</tr>
<tr>
<td></td>
<td>• getXMLAnswer(callback)</td>
</tr>
<tr>
<td></td>
<td>• getJSON(callback)</td>
</tr>
<tr>
<td></td>
<td>• setErrorCallback(errorCallback)</td>
</tr>
<tr>
<td></td>
<td>• getURL()</td>
</tr>
<tr>
<td></td>
<td>• getParams()</td>
</tr>
<tr>
<td></td>
<td>• execute()</td>
</tr>
<tr>
<td></td>
<td>• successCallback(data, status, xhr)</td>
</tr>
<tr>
<td></td>
<td>• errorCallback(xhr)</td>
</tr>
<tr>
<td></td>
<td>• setScope(scope)</td>
</tr>
</tbody>
</table>

**Note:** Because the mobile platform does not allow synchronous GlideAjax calls, the getXMLWait() method in a GlideAjax call does not work in the Service Portal. Instead, use one of the asynchronous calls such as getXML(Function callback) or getXMLAnswer(Function callback).

**Note:** GlideAjax cannot be used in a widget client controller.
Activate Service Portal validation scripts

Validate user input in a specific field type using a validation script. In new instances, Service Portal includes XML, Script, Script (Plain), Email, and Version validation scripts by default. If upgrading from a previous release, the Mobile and Service Portal version is not active by default. You must activate the Mobile and Service Portal version of the validation script to validate user input in the Service Portal.

Role required: admin

Service Portal requires that the **UI Type** field be set to **All** or **Mobile / Service Portal**. Client Scripts marked as **Desktop** rely on legacy APIs that are not supported in Service Portal. Before flagging a script as **Mobile / Service Portal** or **All**, make sure you are only using supported client-side APIs. See [Supported client script types and APIs](#).

**Note**: To change the UI Type from **Mobile / Service Portal** to **All**, delete the Desktop version from your instance to avoid activating conflicting scripts. Before deleting the Desktop version, make a backup in case you need to revert any changes.

1. Navigate to **System Definition > Validation Scripts**.
2. Open the Mobile / Service Portal version of the validation script you would like to use in the Service Portal.
3. Click the **Active** flag to activate the validation script.

---

<table>
<thead>
<tr>
<th>Class</th>
<th>Available methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlideRecord</td>
<td>• addQuery(encodedQuery)</td>
</tr>
<tr>
<td></td>
<td>• addQuery(fieldName, operator, value)</td>
</tr>
<tr>
<td></td>
<td>• getEncodedQuery()</td>
</tr>
<tr>
<td></td>
<td>• get(id)</td>
</tr>
<tr>
<td></td>
<td>• getTableName()</td>
</tr>
<tr>
<td></td>
<td>• hasNext()</td>
</tr>
<tr>
<td></td>
<td>• insert(callback)</td>
</tr>
<tr>
<td></td>
<td>• gotoTop()</td>
</tr>
<tr>
<td></td>
<td>• next()</td>
</tr>
<tr>
<td></td>
<td>• loadRow(rowObj)</td>
</tr>
<tr>
<td></td>
<td>• getValue(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• setValue(fieldName, value)</td>
</tr>
<tr>
<td></td>
<td>• isDotWalkField(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• addOrderBy(fieldName)</td>
</tr>
<tr>
<td></td>
<td>• setDisplayFields(fieldNames)</td>
</tr>
<tr>
<td></td>
<td>• query(callback)</td>
</tr>
<tr>
<td></td>
<td>• setRows(rowsArray)</td>
</tr>
<tr>
<td></td>
<td>• setTableName(tableName)</td>
</tr>
<tr>
<td></td>
<td>• setLimit(maxInt)</td>
</tr>
<tr>
<td></td>
<td>• getLimit()</td>
</tr>
<tr>
<td>i18NV3</td>
<td>getMessage(String messageKey, Function callback)</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
4. Optional: Set the UI Type to **All** to use the validation script in desktop, mobile, and Service Portal environments. To avoid activating conflicting validation scripts, you must first delete the Desktop version of the script.
   a) Navigate to the desktop version of the validation script you would like to replace. Desktop versions have the **UI Type** field set to **Desktop**.
   b) Open the record.
   c) Right-click the header menu and select **Export > XML (This Record)** to create a backup of the record.
   d) Once the export completes, click **Delete** and confirm the selection.
   e) Navigate back to the validation script set to **Active** in earlier steps and change the **UI Type** to **All**.

User input into the designated field type in the Service Portal and Mobile environments is validated for correct formatting. For example, if you activated the Email validation script for use in the Service Portal, invalid user input into an Email field generates an error and prevents the browser from submitting the form.

**Note:** On a desktop browser, the field is validated when you submit the record. On a mobile browser, the field is validated when you navigate away from the field.

**Domain separation in Service Portal**

This is an overview of domain separation and the Service Portal. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Overview**

**Support: Data only**

Domain separation provides complete data isolation for domain-specific users. Domain separation in this application is supported at the **Data only** level, meaning it supports the data security model of separating visibility of data from one domain to another. To learn more, see Application support for domain separation.

**How domain separation works in Service Portal**

Elements of the Service Portal platform such as settings, portals, pages and widgets cannot be domain-separated. However, the data within widgets does display, based on domain. Separate portals with different URLs can be created to provide different experiences for different domains.

**Antivirus Scanning in Service Portal**

View the health status of file attachments in Service Portal. Antivirus Scanning scans files in the Attachments [sys_attachments] table by default. When viewed from a Service Portal page, attachments may not be available for download depending on their health status.

**Note:** Antivirus Scanning is a Now Platform feature. For more information, see Antivirus Scanning.
Scanning scenarios

Review these scanning scenarios to understand how Antivirus Scanning interacts with attachments in Service Portal.

Upload a file

1. A user uploads an infected file to a record in Service Portal.
2. The system scans the file, moves it to quarantine, and displays a message. The file is unavailable for download. If viewing the record in the Ticket Form page, the thumbnail does not display.
3. The system sends an email notification to the user and the antivirus administrator.
Microsoft Wired Keyboard

PC / Mac Compatible

Microsoft Wired Keyboard 200:

- PC/MAC compatible
- USB interface

⚠️ Your file Infected file.txt failed the security scan. Your system is still safe - we quadruple check. You can contact your admin for more info.
Download a file

1. A user opens a record with an attachment in Service Portal.
2. The system scans the file and moves it to quarantine. The file is unavailable for download. If viewing the record in the Ticket Form page, the thumbnail does not display.
3. The system sends an email notification to the user and the antivirus administrator.
View a file

1. A user opens a record with an infected attachment.
2. The file is unavailable for download. If viewing the record in the Ticket Form page, the thumbnail does not display.

Set up Service Portal

Set up a site for your users using Service Portal.

Requirements


Role required: admin or sp_admin
Before you begin

Take the following into consideration before configuring Service Portal:

- Who are you building your site for and why?
- What information do you want to include in your site?
- What do you want the mobile experience to be for users?
- Which platform applications do you plan to use in your portal?

You can use parts of the platform, such as knowledge articles and catalog items, as the content for your portal.

For example, if you are building a knowledge portal, the content displays in Service Portal, but the knowledge articles are authored and managed in the Knowledge application. The same is true for any other type of content you plan to leverage. It is important to take time to understand the table structure of data to become acquainted with content.

- How customized is your service catalog? Catalog client scripts and UI policies only work in Service Portal if they use the mobile GlideForm API, so you may need to make some changes.

What to do

Create a portal

A portal is the engine that houses all the references to content for your site. The portal record defines the URL extension for a site, as well as things like the knowledge base, catalog, and homepage. You can also use the portal record to define the header menu and the portal branding.

From the Service Portal configuration page, click the New Portal tile. Use the fields on the form to associate pages to the portal.

- Create a portal

Create a page

Pages are the centerpiece of the end user experience. Page definitions not only control the layout of the content, they craft the experience for the user. Pages also help define mobile responsiveness, which is a key component in the user experience.

Use any existing page included with Service Portal as an example for your own creation.

Use the Service Portal Designer to create pages, assign layouts, and add widgets.

- Create and edit a page using the Service Portal Designer

Create a widget

Widgets are the power behind the portal. Widgets are highly customizable and can be used to provide an endless variety of experiences for your users. Anytime you add a widget to a page it becomes an instance of itself. Each widget instance has its own record so you can configure it specifically for each use. For example, you can add several Icon Link widgets to a page and configure them to link to different areas with different icons. None of the widgets are affected by the others.

You can start by cloning an existing widget and making changes to your cloned version. Developers with an advanced understanding of AngularJS can create widgets from scratch.

Create a portal homepage
When a portal is referenced by the URL suffix, it lands on a home page. This homepage is often labeled index in website language. The home page is probably the most important page of your portal as it houses the major information and actions that your users see.

- Assign a homepage to a portal

Configure the header menu

The header menu in a portal is comprised of two separate widgets: a header widget, which determines the style of the header, and the menu widget, which determines the actual items that appear in the header. Configure both widgets for the header menu to appear and act like a header menu in your portal.

- Create a portal header menu
- Add a header or footer to a portal

Configure the branding for the portal

With the Branding Editor, you can configure the styles and theme of your portal in a view with real-time updates. You can see how your portal appears to users with the click of a button. More advanced users still have the option of creating CSS style sheets for the portal theme. However, they cannot take advantage of the real-time update that the Branding Editor provides. Changes made in the Branding Editor or to specific components of the portal (such as a widget or a page container) override any customizations made to the theme.

- Configure portal branding
- Create a portal theme

Next steps

- Configure search in the portal.
- Limit user access to specific components.
- Set up URL redirects.

Service Portal configuration page

Most Service Portal configuration is accessible through the Service Portal configuration page landing page.

In your instance, access the Service Portal configuration page by navigating to Service Portal > Service Portal configuration. The Service Portal configuration page opens in a new tab in your browser.
Service Portal
Create rich, engaging and modern experiences to help your business run better
Select one of the options below to continue

- **Branding Editor**
  Customize your portal's title, logo and theme colors.
  Preview changes as you make them

- **Designer**
  Create and layout pages with drag-and-drop functionality.
  Preview pages as you make changes

- **Page Editor**
  Configure the properties of pages, containers and widgets from a map view

- **Widget Editor**
  Create widgets from scratch or customize an existing one. Write HTML, CSS, and JavaScript with real-time preview

- **New Portal**
  Create a new Service Portal

- **Get Help**
  Browse guides, tutorials and videos to learn how to set up, configure and customize your portals
You can also access the configuration page by appending your URL with sp_config. For example, https://<instance name>.service-now.com/sp_config.

Use each option on the Service Portal config page to set up the different parts of your portal.

**Service Portal properties**

The Service Portal properties page provides several configuration options for Service Portal. Administrators can access these properties by navigating to Service Portal > Properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default 404 page (page ID or sp_page sys_id) for Service Portal <strong>glide.service_portal.default_404_page</strong></td>
<td>Set the default page that your users see whenever a page cannot load properly.</td>
</tr>
</tbody>
</table>
| **glide.service_portal.default_404_page** | **Type:** string  
**Default value:** 404  
**Learn more:** Assign a default error page |
| Enable Social Q&A in Service Portal **glide.sp.socialqa.enabled** | Allow users to ask questions in a portal using the social Q&A widgets. |
| **glide.sp.socialqa.enabled** | **Type:** true | false  
**Default value:** true |
| Show a message to admin users in Service Portal pages if a browser error is encountered **glide.sp.show_console_error** | |
| **glide.sp.show_console_error** | **Type:** true | false  
**Default value:** true |
| Maximum number of stream entries displayed in Service Portal (activity widget, conversation widget, and so on) **glide.service_portal.stream_entry_limit** | Limit the number of entries users can see in the ticket conversation widget. Users only see the most recent entries and cannot go further back in the history than the max allowed amount. |
| **glide.service_portal.stream_entry_limit** | **Type:** integer  
**Default value:** 100 |
| Duration (in seconds) info and error messages persist in the Service Portal before auto-dismissal **glide.service-portal.notification_timeout.seconds** | Set the duration in seconds that error and info messages remain on the screen before they are auto-dismissed. If set to 0, messages do not auto-dismiss and require that a user close them. |
| **glide.service-portal.notification_timeout.seconds** | **Type:** integer  
**Default value:** 5 |

If the glide.ui.accessibility preference is enabled, messages do not auto-dismiss, regardless of the system property value. To set this preference, see Enabling accessibility features.
### Default sort order for announcements

**Property**: `glide.service_portal.announcement.default.sort_order`  
**Description**: Define the sort order for banner announcements.  
**Type**: choice list  
**Default value**: Start Date Descending  
**Options include**:  
- **Start Date Ascending**: The oldest start date appears first.  
- **Start Date Descending**: The most recent start date appears first.  
- **End Date Ascending**: The oldest end date appears first.  
- **End Date Descending**: The most recent end date appears first.

### Enable debug runtime information

**Property**: `glide.sp.debug`  
**Description**: Controls whether the Angular.js flag `$compileProvider.debugInfoEnabled` is set to true or false. This option allows debug runtime information in the compiler, such as adding binding information and a reference to the current scope on to DOM elements. This property is disabled by default to improve performance on the instance.  
**Type**: true | false  
**Default value**: false

If user criteria [com.glide.service-portal.user-criteria](#) is enabled, the following properties also appear in the Service Portal properties page:

### User criteria properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable use of User Criteria records instead of Roles fields for Service Portal entitlements | Define permissions for Service Portal widgets, widget instances, pages, and search sources.  
- **Type**: true | false  
- **Default value**: true  
- **More information**: User criteria for Service Portal |
| List of roles (comma-separated) that bypass User Criteria validation in Service Portal | Allow users with a specific role to see any page, widget, widget instance, or search source regardless of user criteria.  
- **Type**: string  
- **Default value**: admin |

### Create a portal

Create a portal using the Service Portal configuration page.  
**Role required**: admin or sp_admin

The Branding Editor affects the look of your portal and essentially changes the CSS for the pages. The changes you make in the Branding Editor are recorded in the portal record in the following fields. If you
have experience with CSS and HTML you can configure these fields in the portal form directly as accessed through the portal UI. By theming your portal in the Branding Editor instead, you can take advantage of the real-time theme preview.

1. Navigate to Service Portal > Portals, then click New.
2. Complete the portal form using the following fields.

### Portal form fields

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The name you use to define your portal. In the browser header and for bookmarks, the title appears as <code>&lt;Portal Title&gt; - &lt;Page Title&gt;</code></td>
</tr>
<tr>
<td>URL Suffix</td>
<td>The value that appears appended to an instance URL when you access a portal. For example, if you use sp, the instance URL for that portal would be <code>&lt;instance name&gt;.service-now.com/sp</code>. Make sure this value is unique and is not the same as any other portal. <em><strong>Note:</strong> Avoid using reserved words in your URL to prevent errors when navigating to your portal page. Words such as portal and cms should not be used. Also avoid any javascript protected terms.</em>**</td>
</tr>
<tr>
<td>Homepage</td>
<td>The page you want users to see first after they sign in.</td>
</tr>
<tr>
<td>Social QA Knowledge Base</td>
<td>Name of the knowledge base where you want to store questions and answers from portal users.</td>
</tr>
<tr>
<td>KB home page</td>
<td>The home page you created that you want users to see when they go to a knowledge base.</td>
</tr>
<tr>
<td>Login page</td>
<td>The page you created for users to be authenticated.</td>
</tr>
<tr>
<td>Logo</td>
<td>Logo that appears in the page header. You can also configure the logo in the Branding Editor.</td>
</tr>
<tr>
<td>Icon</td>
<td>The icon that appears in the address bar for your portal. Each portal you create can have a different icon.</td>
</tr>
<tr>
<td>Default</td>
<td>The portal you want to use as your main portal.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Quick start config</td>
<td>Schema that defines configuration items in the Branding Editor. In JSON format, you can define fields and records used to generate your branding options.</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>CSS variables</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Use the CSS variables field to define CSS variables only. Use CSS Includes to define CSS rules. As of the Madrid release, Sass and LESS can be used within CSS rules. For more information on CSS includes, see Create a portal theme.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope. This field is uneditable and <strong>Global</strong> by default</td>
</tr>
<tr>
<td>404 page</td>
<td>The default page your users see whenever a page cannot load properly. You can also define a default 404 page using the system property glide.service_portal.default_404_page</td>
</tr>
<tr>
<td>Catalog home page</td>
<td>Catalog page that you created in the portal to represent the catalog.</td>
</tr>
<tr>
<td>Main menu</td>
<td>Reference to the menu in the [sp_instance_menu] table that appears in the header</td>
</tr>
<tr>
<td>Theme</td>
<td>Refers to a theme in the [sp_theme] table that defines the style and branding for the portal. The theme is the lowest level of style configuration and any changes made in the Branding Editor or to specific portal components (such as widget or container CSS) override those styles.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Hide portal name</td>
<td>Option to hide the portal name in the page title.</td>
</tr>
<tr>
<td><strong>New Service Portal</strong></td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>Documentation portal</td>
</tr>
<tr>
<td><strong>URL suffix</strong></td>
<td>doc_help</td>
</tr>
<tr>
<td><strong>Homepage</strong></td>
<td></td>
</tr>
<tr>
<td>index</td>
<td>X</td>
</tr>
<tr>
<td><strong>Knowledge base</strong></td>
<td></td>
</tr>
<tr>
<td>Knowledge</td>
<td>X</td>
</tr>
<tr>
<td><strong>Social QA Knowledge Base</strong></td>
<td></td>
</tr>
<tr>
<td>Social QA</td>
<td>X</td>
</tr>
<tr>
<td><strong>KB home page</strong></td>
<td></td>
</tr>
<tr>
<td>kb_view2</td>
<td>X</td>
</tr>
<tr>
<td><strong>Login page</strong></td>
<td></td>
</tr>
<tr>
<td>login</td>
<td>X</td>
</tr>
<tr>
<td><strong>Application</strong></td>
<td></td>
</tr>
<tr>
<td>Global</td>
<td></td>
</tr>
<tr>
<td><strong>404 page</strong></td>
<td></td>
</tr>
<tr>
<td>404</td>
<td></td>
</tr>
<tr>
<td><strong>Catalog</strong></td>
<td></td>
</tr>
<tr>
<td>Service Catalog</td>
<td></td>
</tr>
<tr>
<td><strong>Catalog home page</strong></td>
<td></td>
</tr>
<tr>
<td>scc_home</td>
<td></td>
</tr>
<tr>
<td><strong>Main menu</strong></td>
<td></td>
</tr>
<tr>
<td>SP Header Menu</td>
<td></td>
</tr>
<tr>
<td><strong>Theme</strong></td>
<td></td>
</tr>
<tr>
<td>Stock</td>
<td></td>
</tr>
</tbody>
</table>
3. Click **Submit** to save the portal page.

4. In the **Knowledge Bases** related list, click **Edit** to select which knowledge bases appear for the knowledge base page. For example, if you select **IT** and **Instance Security Center**, only the article categories defined for these knowledge bases appear in the **KB categories widget**.

5. In the **Catalogs** related list, click **Edit** to select one or more catalogs listed in the sc_catalog table to use in the portal.

**Configure a catalog in Service Portal**

Associate a portal with multiple catalogs. By default, Service Portal is associated with Service Catalog.

Role required: admin or sp_admin

1. Navigate to **Service Portal > Portals**.
2. Click the **Service Portal** record.
3. To associate a portal with a catalog, perform the following steps.
   a) In the **Catalogs** related list, click **Edit**.
   b) Select one or more catalogs to add to the portal. The categories and catalog items associated with the selected catalogs are displayed in Service Portal.

   **Note:** If no catalogs are selected, all active catalogs accessible to the requester are available in Service Portal.

4. Optional: To edit the label for a catalog, perform the following steps.
   a) For the **Main menu** field, click **Open Record**.
   b) From the **Menu Items** section, Click the **Catalog** record.
   c) In the **Label** field, specify the label for the catalog. The catalog label is displayed in the main menu of Service Portal.

5. Click **Update**.

**Associate a portal with a knowledge base**

You can associate a portal with any knowledge base. Multiple knowledge bases can be associated with a portal.

Role required: admin or sp_admin

1. Navigate to **Service Portal > Portals**.
2. In the **Knowledge Bases** related list. Click the **Edit** button.
3. Select one or more knowledge bases to add to the portal. The knowledge bases are displayed in Service Portal page listed in the **KB Home page** for the portal. If no knowledge bases are selected, all knowledge bases are available in the portal.

4. Click **Update**.

**Configure Agent Chat in Service Portal**

Your end users can initiate and maintain an Agent Chat conversation in any portal page. Write a script to pass portal-specific data to Agent Chat. For example, pass the name of your knowledge base to a Virtual Agent conversation.

Role required: admin
• Activate the Glide Virtual Agent (com.glide.cs.chatbot) or the Agent Chat (com.glide.interaction.awa) plugin. You can activate the Glide Virtual Agent plugin only if you have a subscription.

1. Navigate to **Service Portal > Agent Chat**.
   The Service Portal Agent Chat Configurations [sp_agent_chat_config] table opens.
2. Click **New**.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select to make the configuration active.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a unique name for the configuration record.</td>
</tr>
<tr>
<td>Portals</td>
<td>Select the portals in which you would like to use the specified chat</td>
</tr>
<tr>
<td></td>
<td>configuration. If no portal is selected, the configuration applies to all</td>
</tr>
<tr>
<td></td>
<td>portals in the system.</td>
</tr>
<tr>
<td>Application</td>
<td>Read-only application scope for the record.</td>
</tr>
<tr>
<td>Public</td>
<td>Select to make Agent Chat available to users before they log in.</td>
</tr>
<tr>
<td>Roles</td>
<td>Select the roles a user must have to use Agent Chat. If you don’t select a</td>
</tr>
<tr>
<td></td>
<td>role, Agent Chat is available to all users regardless of their role.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number indicating the order that the configurations should run. Only</td>
</tr>
<tr>
<td></td>
<td>one configuration applies per portal. If there are multiple configurations</td>
</tr>
<tr>
<td></td>
<td>on a portal, the system runs the first configuration found from lowest to</td>
</tr>
<tr>
<td></td>
<td>highest.</td>
</tr>
<tr>
<td>Server script</td>
<td>Write a script that passes page and widget data to an Agent Chat conversation</td>
</tr>
<tr>
<td></td>
<td>when a user initiates the conversation. For example, pass a field to the</td>
</tr>
<tr>
<td></td>
<td>chat conversation to enable Agent Chat to access the value. Data passed in</td>
</tr>
<tr>
<td></td>
<td>this script is available to every page in the portal associated with this</td>
</tr>
<tr>
<td></td>
<td>record. This script has access to the GlideSPScriptable API.</td>
</tr>
</tbody>
</table>

**Note**: The portal suffix, page ID, and language are automatically available to Agent Chat and do not require a custom script. Sys ID and table are automatically available to Agent Chat when they are present in the URL.

```javascript
(function ($sp) {
    return {
        catalogs: $sp.getValue('catalogs')
    };
})(sp);
```

This example returns an object containing the list of catalogs associated with the portal to the current conversation.

When Agent Chat opens in an *iframe* HTML element, the list of catalogs is included in the *iframe* URL. Parameters from this field override any conflicting page data passed to Agent Chat.

4. Click **Submit**.

Users can initiate and maintain an Agent Chat conversation from any page in the selected portal.

**Migrate from the Virtual Agent Service Portal widget**

If upgrading from a previous release, your portal implementation may include the Virtual Agent Service Portal widget. Migrate widget options to the Agent Chat in Service Portal configuration and remove all
instances of the widget to enable your users to initiate and maintain an Agent Chat conversation in any portal page.

1. Record instance options and delete instances of the Virtual Agent Service Portal widget.
   a) Locate each instance of the Virtual Agent Service Portal widget and open the instance options.
   b) Record the values.
   c) Delete the widget instance.

2. If your widget instance included a color instance option, add the color variable to the portal theme record.
   a) Navigate to Service Portal > Themes.
   b) Open the theme record for the portal.
   c) In the CSS variables field, add the $sp-agent-chat-bg variable and set the value to the desired color.

\[
\text{$sp-agent-chat-bg: \#ff0000}$
\]

3. If your widget instance options included URL parameters, add them to the Service Portal Agent Chat Configurations form Server script field.

   Note: The portal suffix, page ID, and language are automatically available to Agent Chat and do not require a custom script. Sys ID and table are automatically available to Agent Chat when they are present in the URL.

   a) Navigate to the record in the Service Portal Agent Chat Configurations [sp_agent_chat_config] table for the desired portal.
   b) In the Server script field, write a custom script to pass the parameters to Agent Chat.

   This example returns the value of the chat_queue field to the current conversation.

\[
(function ($sp) {
  return {
    chat_queue: $sp.getValue('chat_queue')
  };
})(\$sp);
\]

Widget instances are removed from individual portal pages. Instead, the portal applies the Service Portal Agent Chat Configurations record to every portal page.

**Pass page data to Agent Chat**

Use the spContextManager class in a widget client script to pass dynamic page data to Agent Chat. For example, pass the number of approvals in the Approvals widget to Agent Chat when a user initiates a conversation from the Service Portal homepage.

Role required: admin

Examine the widget to understand how data is passed to the widget client script. To make data available to Agent Chat, you must pass it to the spContextManager service. You can then access the data in a Virtual Agent topic using the vaContext object. For more information about using context variables in Virtual Agent scripts, see Virtual Agent scripts.

1. Open the widget in the widget editor.
2. Update the widget client script.
a) Inject the `spContextManager` service into the widget client script function.

b) Pass variables to Agent Chat using the `spContextManager` API.

This example passes `approval_count` to Agent Chat. When a user initiates a conversation from the Service Portal homepage, the system appends `&sysparm_approval_count=5` to the Agent Chat iframe URL.

```javascript
function ($scope, spContextManager) {
  spContextManager.addContext('agent-chat', {
    'approval_count': 5
  });
}
```

Keys passed to this API are unique per page. For example, if the `agent-chat` key is already initialized by another widget on the page through the `addContext()` method, you must use the `updateContextForKey()` method to update the key's data. For more information about the `spContextManager` class, see `spContextManager`.

3. Click **Save**.
4. Use Service Portal data in a Virtual Agent topic.
   a) Navigate to **Virtual Agent > Designer** and open the topic in which you would like to use Service Portal data.
   b) Click **Edit Topic Flow**.
   c) Configure the topic as needed. In a script field, use the `vaContext` object to access the context variable passed from the Service Portal.

For more information about creating a Virtual Agent topic, see **Create a Virtual Agent topic**.

For example, this script accesses the value of the `approval_count` variable in the Approvals widget.

```javascript
(function execute() {
  return "Your approval count is: " + vaContext.approval_count;
})()
```

d) Save and publish the topic.

Agent Chat can access the variables when an end user initiates a conversation from the Service Portal page.
Remove Live Chat link from the header menu

If your portal includes a Live Chat link in the header menu, you can remove it by updating the widget's option schema.

Role required: admin
Adding the Chat Queue field to a portal record adds the Live Chat link to the portal's header menu. If you integrate your portal with Agent Chat, the Live Chat link is no longer needed.

1. In the Service Portal configuration page, navigate to Portal Tables > Instance with Menu.
2. Open the record for your portal's header menu. For example, open SP Header Menu if using the base system portal.
3. In the Additional options, JSON format field, add the following JSON key-value pair.

   ```json
   "enable_live_chat": {
     "displayValue": "false",
     "value": false
   }
   ``

   The final JSON looks like this.

   ```json
   {
     "enable_cart": {
       "displayValue": "true",
       "value": true
     },
     "enable_wishlist": {
       "displayValue": "true",
       "value": true
     },
     "enable_live_chat": {
       "displayValue": "false",
       "value": false
     }
   }
   ``

4. Click Update.

When you navigate to the portal, Live Chat does not appear in the header menu.

Service Portal styles

Pages are made up of containers, columns, rows, widgets, and widget instances. You can configure the CSS of each component, or use the CSS defined in theme and branding as global definitions for the portal. If you do not define CSS in theme or branding, Bootstrap defaults are used.

You can define CSS in your portal at multiple levels.

Bootstrap defaults

If no other CSS is defined, all elements use Bootstrap version 3.3.6 defaults. You can use Bootstrap CSS Helper Classes with any Service Portal field that accepts CSS as a value. To show or hide Service Portal containers, use Bootstrap CSS Responsive Utilities Helper Classes such as visible-lg or hidden-md.

Branding editor theme colors/Portal CSS

CSS defined in the Branding Editor Theme Colors tab. Changes made to the theme colors in the Branding Editor appear in the CSS variables field in the portal table [sp_portal].
Customizing the theme colors overwrites the Bootstrap defaults.

**Theme CSS**

CSS defined in the CSS variables field in the Themes table [sp_theme]. Use the Theme CSS as much as possible to allow for more flexible evolution of your portal in the future.

Using a theme overwrites the Portal CSS/Branding Editor theme colors.

**Page CSS**

CSS defined in the Page Specific CSS field in the Pages table [sp_page].

Page-specific CSS overwrites the theme CSS.

**CSS classes**

You can define CSS classes elements on the page within each respective record.

**Widget CSS**

CSS defined in the CSS field in the Widgets table [sp_widget].

Widget CSS overwrites container, column, and row CSS.

**Widget instance CSS**

CSS defined in the CSS field in the Instance table [sp_instance].
Widget instance CSS overwrites all other CSS definitions.

Configure portal branding

Use Branding Editor to give your portal its own look and feel.

To access the Branding Editor, navigate to **Service Portal > Service Portal Configuration**, then click **Branding Editor**.

Select the portal you want to customize the theme for from the portal list. Then use the options on the Quick Setup and Theme Colors tabs to customize your portal.
Branding Editor

Quick Setup tab options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portal Title</td>
<td>The name of your portal. Changing the name of the portal in the Branding Editor also changes the title on the portal form field in the platform UI.</td>
</tr>
<tr>
<td>Logo</td>
<td>The logo that appears in the header for your portal. This image is scaled to a maximum height of 46 px and a maximum width of 200 px.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Logo padding</td>
<td>Where you want the logo to sit in location to the edge of the header. This information is stored in the CSS variables section on the portal form.</td>
</tr>
<tr>
<td>Tag line &amp; background</td>
<td>Fields defined by the JSON schema in the <strong>Quick start config</strong> field on the portal record in the platform UI. The sample Service Portal adds <strong>Tag Line</strong> and <strong>Background</strong> to the Branding Editor using the following schema:</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>[{</td>
</tr>
<tr>
<td></td>
<td>&quot;tagline&quot;: {</td>
</tr>
<tr>
<td></td>
<td>&quot;table&quot;: &quot;sp_instance&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;: &quot;34fe3d96cb20020000f8d856634c9cf4&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;field&quot;: &quot;title&quot;</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>&quot;hero_background&quot;: {</td>
</tr>
<tr>
<td></td>
<td>&quot;table&quot;: &quot;sp_container&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;: &quot;be98a8d2cb20020000f8d856634c9c63&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;field&quot;: &quot;background_image&quot;</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td>Tag line</td>
<td>Introduce your users to a portal page with a tag line. This text is stored in an instance of the homepage search widget.</td>
</tr>
<tr>
<td>Tag line color</td>
<td>Select a color for the tag line.</td>
</tr>
<tr>
<td>Homepage background color</td>
<td>Add a color for your background. You can type in a color name, hex color, decimal (RGB), or select from the color palate.</td>
</tr>
<tr>
<td>Background image</td>
<td>Upload an image to appear in the background of your homepage. This image is stored in the container for the widget on your homepage.</td>
</tr>
</tbody>
</table>

For any colors on the theme tab, you can use the standard color name, hex code, decimal (RGB) code, or select the color from the color palate. All the color definitions are stored in the CSS variables field of the portal form. The theme preview updates in real time as you make changes.

**Theme colors tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navbar</td>
<td>Use the fields in this section to customize the colors for the header menu.</td>
</tr>
<tr>
<td>Brand</td>
<td>Use the fields in this section to customize the page colors. For example, the page background or the widget background.</td>
</tr>
<tr>
<td>Text</td>
<td>Use the fields in this section to customize the color of the text on a page.</td>
</tr>
</tbody>
</table>

Changes made to the theme colors in the Branding Editor appear in the CSS variables field of the portal form in the platform UI.
Activate La Jolla theme branding

Activate the Service Portal La Jolla Brand to apply the latest ServiceNow branding, which includes WCAG-AA compliance for contrast. This plugin is active by default on new instances, but admins must activate the plugin on instances upgraded from earlier versions.

Role required: admin

The Service Portal La Jolla Brand Update activates these related plugins if they are not already active.

**Plugins for Service Portal La Jolla Brand Update**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal La Jolla Brand [com.glide.service-portal.themes.la-jolla]</td>
<td>This plugin updates your /sp and /sp_config portals with the ServiceNow La Jolla branding. If the portal record has not been modified, the logo, favicon, login page background image, hero banner, theme, and widget instance options are updated.</td>
</tr>
</tbody>
</table>

**Note:** If you have modified the /sp or sp_config portal pages before installing the plugin, you may not see all elements of the La Jolla branding. All branding images are located in the db_image table for manual updates to your custom portals.

To purchase a subscription, contact your ServiceNow account manager. After purchasing the subscription, activate the plugin within the production instance.

You can evaluate the feature on a sub-production instance without charge by requesting it from the HI Customer Service System.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Create a portal theme

If you need more customization than Branding Editor can provide, you can create your own custom theme.
Only users with an understanding of CSS should create custom themes.

1. Navigate to **Service Portal > Themes**, then click **New**.

![Image of New Theme form](image)

2. Complete the form fields and select **Save**.

**Theme form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your theme. Use this name to associate the theme with your portal. This name is not visible to users, you should know it to apply the correct theme to a portal.</td>
</tr>
<tr>
<td>Application</td>
<td>The record scope. The header menu record and the source table must have the same application scope.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Header</td>
<td>List of headers and footers from the sp_header_footer table that you can associate with a portal theme. Headers and footers are widgets and can be configured the same way.</td>
</tr>
<tr>
<td>Footer</td>
<td>List of headers and footers from the sp_header_footer table that you can associate with a portal theme.</td>
</tr>
<tr>
<td>Fixed header</td>
<td>Locks the header at the top of the page so that when a user scrolls the header remains on the screen.</td>
</tr>
<tr>
<td>Fixed footer</td>
<td>Locks the footer at the bottom of the page so that when a user scrolls the footer remains on the screen.</td>
</tr>
<tr>
<td>CSS variables</td>
<td>CSS custom properties that you can use to change the color and styles in a portal. For example, the stock theme uses some of the following variables:</td>
</tr>
<tr>
<td></td>
<td>$sp-logo-margin-x: 15px !default;</td>
</tr>
<tr>
<td></td>
<td>$sp-tagline-color: $text-color !default;</td>
</tr>
<tr>
<td></td>
<td>$navbar-inverse-bg: #3a3f51 !default;</td>
</tr>
</tbody>
</table>

**Note:** Use the CSS variables field to define CSS variables only. Use CSS Includes to define CSS rules. As of the Madrid release, Sass and LESS can be used within CSS Includes. For more information on CSS Includes, see Create a portal theme.
3. To add a style sheet to the theme, in the **CSS Include** related list, click **New**.

![CSS Include record](image)

**CSS include record**

4. Complete the style sheet form fields, then click **Save**.

**Style sheet form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the CSS Include. Remember this name to associate the CSS Include with the theme.</td>
</tr>
<tr>
<td>Application</td>
<td>The record scope. The header menu record and the source table must have the same application scope.</td>
</tr>
<tr>
<td>Source</td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Style Sheet</strong>: Add an internal style sheet that has been uploaded to the CSS table [sp_css]. For example, ng-sortable.min.css. Internal style sheets use standard CSS in the CSS field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>URL</strong>: Link to an external style sheet. Use external style sheets to use the same CSS as a corporate website or other online resource.</td>
</tr>
<tr>
<td>Style sheet</td>
<td>Associate a style sheet or CSS file URL, depending on which option you select in the Source field.</td>
</tr>
</tbody>
</table>
5. To add a JavaScript include to the theme, in the **JS Include** related list, click **New**.

6. Complete the JS Include form fields.

### JS Include form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the JS Include. Remember this name to associate the JS Include with the theme.</td>
</tr>
<tr>
<td>Application</td>
<td>The record scope. The header menu record and the source table must have the same application scope.</td>
</tr>
<tr>
<td>Source</td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>UI Script</strong>: Add an internal UI script that has been uploaded to the UI script table [sys_ui_script]. UI scripts allow you to create client-side JavaScript and reuse it in multiple locations. For more information on UI scripts, see #unique_2806.</td>
</tr>
<tr>
<td></td>
<td>• <strong>URL</strong>: Link to an external JavaScript file. Use external URLs to use the same JavaScript as a corporate website or other online resource.</td>
</tr>
<tr>
<td>UI Script or Java file URL</td>
<td>Associate an internal UI script or Java file URL, depending on which option you select in the Source field.</td>
</tr>
</tbody>
</table>
Configure a portal header menu

Service Portal is designed to allow customers to have deep control over the behavior of their portals. One of the main navigation controls for users is the header main menu. The menu options are determined by the assignment of a main menu to the portal, but the look and behavior of the menu is defined within the theme and associated header.

Configuring a portal header with a menu involves several steps:

1. Create a header and add it to a theme.
   Until you add a theme with a header to a portal, the header menu does not display.

2. Create a main menu with menu items and assign it to the portal.
   The main menu record is where you assign which navigation options appear in the header. For example, you can add a menu item that links to another page within your portal, such as the service catalog.

The main menu and header form a header menu when associated with a theme and a portal.
Add a header or footer to a portal

Use the theme to add a header or footer to your portal.

1. Navigate to the portal theme (Service Portal > Service Portal Configuration > Portal Tables > Themes) then click the theme you want to add the header or footer to.
2. In the header or footer field, select the header or footer you want to use for your portal.
   If you are just getting started, you can reuse the base system Stock Header or Sample Footer widgets.
3. Optional: Select Fixed Header or Fixed Footer to lock the header or footer in one place so when users scroll up or down they remain in the same location on the page.
4. To configure the appearance of the header, in the Service Portal configuration page, open the Branding Editor. Under the Theme Colors tab, use the color selectors in the Navbar section to control the colors in the header.

Create a portal header menu

Create a menu with menu items to display in the header of a portal.

1. In the Service Portal configuration page (Service Portal > Service Portal Configuration), navigate to Portal Tables > Instance with Menu and click New.
2. Complete the fields in the menu form.

   Menu fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the header menu. You need to know this when you associate the menu with your portal.</td>
</tr>
<tr>
<td>Additional options, JSON format</td>
<td>Advanced configuration options. For example, use this field to enable the shopping cart in the header menu with the following code:</td>
</tr>
<tr>
<td></td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;enable_cart&quot;: {</td>
</tr>
<tr>
<td></td>
<td>&quot;displayValue&quot;: &quot;true&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;value&quot;: true</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td>Application</td>
<td>The record scope. The header menu record and the source table must have the same application scope.</td>
</tr>
<tr>
<td>Widget</td>
<td>The widget that the header menu is based on. Select a menu-type widget from the list. For example, the header menu widget that is included as a base system widget.</td>
</tr>
</tbody>
</table>

3. Save the form, and then click Menu Items from the related lists.
4. Click New and complete the menu item form.

   Menu item fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name that appears for the item in the menu</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parent menu</td>
<td>This field should already contain the name of the menu you are adding items to. You can change the value as needed to other menus</td>
</tr>
<tr>
<td>Parent menu item</td>
<td>Use this field to nest menu items within other menu items</td>
</tr>
<tr>
<td>Order</td>
<td>Value that determines where the item appears in the menu in relation to other menu items</td>
</tr>
<tr>
<td>Type</td>
<td>The kind of page the item links to. Form fields vary depending on the option that you select from this list. Choose from:</td>
</tr>
<tr>
<td></td>
<td>• Page: Link to another page in the Service Portal.</td>
</tr>
<tr>
<td></td>
<td>• URL: Link to an external website. To have the URL open on a new browser tab or window, enter _blank in the URL target field.</td>
</tr>
<tr>
<td></td>
<td>• Service Catalog: Link to the Service Catalog.</td>
</tr>
<tr>
<td></td>
<td>• Catalog Category: Link to a specific catalog category within the Service Catalog.</td>
</tr>
<tr>
<td></td>
<td>• Catalog Item: Link to a specific catalog item.</td>
</tr>
<tr>
<td></td>
<td>• Knowledge Base: Link to the knowledge base that you previously configured as the portal's default knowledge base.</td>
</tr>
<tr>
<td></td>
<td>• KB Topic: Link to a KB topic page.</td>
</tr>
<tr>
<td></td>
<td>• KB Article: Link to a KB article by number.</td>
</tr>
<tr>
<td></td>
<td>• KB Category: Link to a specific KB category within the knowledge base.</td>
</tr>
<tr>
<td></td>
<td>• Filtered List: Set conditions to determine which page to link to.</td>
</tr>
<tr>
<td></td>
<td>• Scripted List: Enter a script to determine which page to link to.</td>
</tr>
<tr>
<td>Page</td>
<td>Name of the portal page the item links to. This option is available if you select Page as the menu item type.</td>
</tr>
<tr>
<td>Condition</td>
<td>Determines what conditions are required for menu items to show in the header. For example, the condition gs.hasRole(&quot;sp_admin&quot;) restricts access to menu items to users with the sp_admin role. Hide a menu item by setting this value to false. For more information on what conditions to use in the Condition field, see Create a UI Action .</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon that appears beside the menu item</td>
</tr>
</tbody>
</table>

5. Click Submit.
6. After you create a menu and menu items, add the menu to a portal.
   a) Navigate to **Service Portal > Portals**, then open the portal you want to add a menu to.
   b) From the main menu field, click the reference lookup icon, then select the appropriate menu by name.
<table>
<thead>
<tr>
<th>Title</th>
<th>Documentation portal</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL suffix</td>
<td>doc_portal</td>
</tr>
<tr>
<td>Homepage</td>
<td>Index</td>
</tr>
<tr>
<td>Knowledge bases</td>
<td></td>
</tr>
<tr>
<td>KB home page</td>
<td>kb_view2</td>
</tr>
<tr>
<td>Login page</td>
<td>lading</td>
</tr>
<tr>
<td>Application</td>
<td>Global</td>
</tr>
<tr>
<td>Catalog</td>
<td>Service Catalog</td>
</tr>
<tr>
<td>Catalog home page</td>
<td></td>
</tr>
<tr>
<td>Main menu</td>
<td></td>
</tr>
</tbody>
</table>

### Quick start config

```json
{"tagList: [{
  "title": "SP Config Menu",
  "icon": "folder",
  "children": [
    {
      "title": "Documentation menu",
      "icon": "book"
    },
    {
      "title": "SP Header Menu",
      "icon": "header"
    },
    {
      "title": "Benchmarks Menu",
      "icon": "chart"
    },
    {
      "title": "CAPI Workbench Menu",
      "icon": "folder"
    }
  ]
},
{
  "title": "Page Menu",
  "icon": "page"
}]
```

CSS variables:

```
grid-gutter-width
```
c) Click **Save**.

Associate the menu you created with a portal, then create a header with a theme for your menu.

**Service Portal pages**

Use pages to organize content, ensure responsive mobile optimization, and design meaningful portal user experiences for your customers. A page houses containers and rows, which then contain widgets. By manipulating the layout of the page, and the widgets within it, you can construct your desired user experience.

- Pages are referenced using the page ID.
- Pages can be referenced in more than one portal.
- Use base system pages as templates.
Containers

Containers are markup artifacts that are put on a page to contain the layouts that house the widgets.

You can view containers and how they make up a page in the Service Portal Designer (Service Portal > Service Portal Configuration > Designer). Open a page in the Service Portal Designer, then click anything on the page. In the top left corner, breadcrumbs appear to show you which element on the page you have selected. Use the breadcrumbs to select a container, then click the edit icon ().

Service Portal Designer breadcrumbs

You can also edit a container by navigating to the Page Editor and selecting the container node in the tree view. In this view, you can:

- Change the layout of widgets on a page.
- Determine the number of columns on a page.
- Determine whether to scale with changes to the browser window.
- Add a background color to a portion of a page.
- Add an background image to a portion of a page.
- View the current layout of the widgets within the page.
Create and edit a page using the Service Portal Designer

Create or edit a page and use layouts to organize the columns that house the widgets.

These steps are intended for users with little to no coding experience. The Service Portal Designer includes several layers of customization from simply adding widgets in a particular configuration on a page, to adding CSS classes.

1. Navigate to Service Portal > Service Portal Configuration.
2. Click Designer.
3. Switch to the portal you want to design pages for by selecting the portal name in the header.
4. From the Service Portal Designer, select a page to customize or click Add a new page.
5. Under Layouts, select Container and drag it onto the page.
6. Drag one of the other layouts and drop it in the container.

This layout defines the structure of your page and the space available to drop widgets. The structure of the layout aligns with the Bootstrap grid template and always adds up to 12.
7. Use the filter to search for a widget, then drag the widget to the layout.
Drag containers, layouts, then widgets onto a page.
   a) Click **Edit Page Properties**.
      The page record from the Pages table [sp_page] opens.
   b) Edit the form.

   **Page fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Internal name of the page. Use the title to search for a page in the Service Portal Designer.</td>
</tr>
<tr>
<td>ID</td>
<td>A unique ID for the page. The ID is what you use to assign a page to a portal. It also determines the URL for the page, for example <code>https://instance name.service-now.com/doc_portal/?id=doc_page</code>, where doc_page is the page ID.</td>
</tr>
<tr>
<td>Application</td>
<td>The application scope.</td>
</tr>
<tr>
<td>Public</td>
<td>Enables the page to be accessed without the need for authentication. If <strong>Public</strong> is selected, all users can view the page no matter the roles listed.</td>
</tr>
<tr>
<td>Draft</td>
<td>Mark a page as draft to limit user ability to view the page while you are still creating it. Only users with the admin role can view a page in draft, all other users see a 404 page.</td>
</tr>
<tr>
<td>Roles</td>
<td>Limit user access to a page by role.</td>
</tr>
<tr>
<td>Short description</td>
<td>Describes the portal page. This field is not public facing.</td>
</tr>
<tr>
<td>Page Specific CSS</td>
<td>Unless a page has Page Specific CSS, the page inherits CSS from the Theme and Branding. If you need a page to look different, the Page Specific CSS overrides the inheritance from the Theme and Branding.</td>
</tr>
<tr>
<td>Dynamic page title</td>
<td>Create variables to generate descriptive titles depending on the content loaded into a page.</td>
</tr>
<tr>
<td>Clone Page</td>
<td>Enables you to make a copy of a page that can be modified. If you clone a base system page, a new widget instance is created for each widget on the page.</td>
</tr>
</tbody>
</table>

   a) Click within the container you would like to edit, or select **Container** in the breadcrumbs.
   b) Click the edit icon [ ].
      The container record from the Containers table [sp_container] opens.
   c) Edit the form.

   **Container fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Internal name of the container.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the containers appear on a page. To set a container to appear above all other containers, give the container the lowest number in the Order field.</td>
</tr>
<tr>
<td>Page</td>
<td>The page in which the container appears.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Screen reader title</td>
<td>The title used by a screen reader.</td>
</tr>
<tr>
<td>Application</td>
<td>The application scope.</td>
</tr>
<tr>
<td>Width</td>
<td>Width of the container. Options include:</td>
</tr>
<tr>
<td></td>
<td>• Fixed</td>
</tr>
<tr>
<td></td>
<td>• Fluid</td>
</tr>
<tr>
<td>Parent class</td>
<td>Parent CSS class for the container.</td>
</tr>
<tr>
<td>CSS class</td>
<td>The CSS classes for the container. Overwrites page-specific CSS.</td>
</tr>
<tr>
<td>Background color</td>
<td>The background color of the container.</td>
</tr>
<tr>
<td>Background image</td>
<td>Background image for the container.</td>
</tr>
<tr>
<td>Background style</td>
<td>The display style of a background image. Options include:</td>
</tr>
<tr>
<td></td>
<td>• Default</td>
</tr>
<tr>
<td></td>
<td>• Cover</td>
</tr>
<tr>
<td></td>
<td>• Contain</td>
</tr>
<tr>
<td></td>
<td>• Repeating</td>
</tr>
<tr>
<td>Bootstrap alternative</td>
<td>Selecting this field removes the standard Bootstrap grid classes and disables the Bootstrap grid system in the container. If selected, the following are not applied:</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Width</strong> field in the container record.</td>
</tr>
<tr>
<td></td>
<td>• Standard Bootstrap class in the row record within the container.</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Size - xs</strong>, <strong>Size - sm</strong>, <strong>Size - md</strong>, and <strong>Size - lg</strong> fields in column records within the container.</td>
</tr>
<tr>
<td></td>
<td>Only select this field if you plan to provide custom CSS classes and CSS for the container, row, and column records.</td>
</tr>
<tr>
<td>Move to header</td>
<td>If selected, the container sticks to the header and does not scroll. Use this option to create a subheader.</td>
</tr>
</tbody>
</table>

10. Optional: To switch to a different page, click the **Pages** tab in the left pane, then select the next page you want to configure.
11. Optional: Use the Preview button in the header to view your page as you design it.

You can also use Preview to view your page in mobile or tablet mode through the controls presented in the header.
Designer tablet view
Add a subheader to a page

Select a container record to serve as a page subheader. A subheader sticks to the page header and does not scroll.

Role required: admin

1. From the Service Portal configuration page (Service Portal > Service Portal Configuration) open the Service Portal Designer.
2. Open the page you want to add a subheader to.
3. Click the container that you would like to use as a subheader, or select the container using the breadcrumbs.
4. Click the edit icon (EDIT).
5. Select **Move to header**.

**Container record**

As a subheader, the container sticks to the header and does not scroll.

**Assign a homepage to a portal**

Edit your portal record to specify any page as your homepage.
When a portal is referenced by the URL suffix, it lands on a home page. This homepage is often labeled index in website language. The home page is probably the most important page of your portal as it houses the major information and actions that your users see.

1. From any page in the Service Portal Designer, click **Edit Portal Properties**.

![Edit Portal Properties](image.png)
2. From the Homepage list, select the page you want for your portal homepage and click **Save**.
SP Configuration

- Title
  SP Configuration

- URL suffix
  sp_config

**Homepage**
- sp_config_homepage

- Application
  Global

- Knowledge base

- Social QA Knowledge Base

- KB home page

- Login page
  - login

- Logo
  ![Now Logo]

- Icon
  ![Upload an Image]

- Quick start config
  1

- Theme
  - Stock

CSS variables

Save (F8 + s)
Assign a default error page

Create a default 404 error page for your portal using a system property.

You can assign an error page to a portal using the portal form. If you do not assign an error page using that form, the system uses the default 404 page containing the breakout game widget. Use the default 404 page property `glide.service_portal.default_404_page` to configure the default error page.

Create a page before adding it as the default error page.

1. Navigate to Service Portal > Properties.
2. In the Default 404 page for Service Portals, type the page ID found in the ID field of the page form.

Add SEO information to Service Portal pages

Improve the searchability of Service Portal pages by adding meta tags and descriptive titles.

You can add SEO information to Service Portal pages by:

- Associating public pages with meta tags to optimize search from external search engines.
- Using record data loaded in a page to dynamically generate descriptive page titles and meta tags.

Dynamic meta tags and titles

Some pages in the Service Portal load record data based on a URL parameter. You can add meta tags and page titles that vary depending on the record loaded in the page.

Using Service Catalog as an example, the following URL includes a sys_id parameter in addition to the page ID. Different content is loaded depending on the value of the sys_id parameter.

```
https://<yourInstance>.service-now.com/sp?id=sc_cat_item&sys_id=060f3afa3731300054b6a3549dbe5d3e
```

If a page loads dynamic content, you can:

- Add meta tags to the page.
- Add meta tags that vary based on content.
- Add variables that generate descriptive page titles based on content.
- Add dynamic content to a page title.
- Create targeted page titles for use with a screen reader.

For example, you can set a Service Catalog page to generate a dynamic title and meta tag based on record data associated with the URL parameter.
Add meta tags to a public page

Improve the searchability of Service Portal pages by adding meta tags. You can add the meta name and description attributes to a page, define the robots attribute, or create dynamic meta tags for pages that load record data based on a URL parameter.

Role required: admin or sp_admin

1. Navigate to Service Portal > Pages.
2. Open a page.
3. Check that **Public** is selected.
   Pages that are not public are not indexed by external search engines.

4. Click the **Meta tags** related list tab.

5. Click **New** to create a new meta tag.

6. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td>Page to apply the meta tag to.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the page. This value is read-only.</td>
</tr>
<tr>
<td>Name</td>
<td>The HTML meta name attribute. To define the meta robots attribute, add <strong>ROBOTS</strong>.</td>
</tr>
</tbody>
</table>
| Content  | The HTML meta description attribute. If **ROBOTS** is defined in the **Name** field, you can add one of the following content values:  
  - **INDEX, FOLLOW**: The search engine shows the page in search results and trusts any links in the page. This is the default value.  
  - **NOINDEX, FOLLOW**: The search engine does not show the page in search results, but trusts any links in the page.  
  - **INDEX, NOFOLLOW**: The search engine shows the page in the search results, but does not trust links in the page.  
  - **NOINDEX, NOFOLLOW**: The search engine does not show the page in search results and does not trust links in the page.  
   Alternatively, you can pass a variable into this field based on record data. For example, you can define a `%description` variable in this field, and create a content variable to populate the content tag with record data. |

[Meta tag form]

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
7. Click **Submit**.
   The meta information is added to the page header. For example:
   ```html
   <meta name="description" content="Order something from the Service Catalog">
   ```

8. Optional: Create a content variable to populate the content tag with record data.
   If the page loads record data based on one or more URL parameters, you can add meta tags generated from the record data.
   a) Open a meta tag record and check that the **Content** field contains a variable, or add a variable.
      Depending on the available URL parameters and the meta tag you would like to define, you can add the following types of values:

<table>
<thead>
<tr>
<th>Value types</th>
<th>Description</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>One URL parameter variable</td>
<td>Populates the content tag with the value defined in the associated content variables record.</td>
<td>%description</td>
</tr>
<tr>
<td>More than one URL parameter variable</td>
<td>Populates the content tag with the values defined in the associated content variables records.</td>
<td>%description %price</td>
</tr>
<tr>
<td>Static value and a URL parameter variable</td>
<td>Populates the content tag with a static value and the associated content variables record.</td>
<td>Catalog item: %description</td>
</tr>
</tbody>
</table>

   b) In the **Content variables** related list, click **New**.
      The **Content variables** related list is only available after saving the meta tag record.
   c) Complete the form.
      Associate a field with a URL query parameter. When the value of the query parameter is used to display content, a field from the same record is used to generate the content tag. You can define the field to generate the content tag through the **Table field** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The variable to store the value. Must begin with % and cannot contain spaces. This value must match one of the variables defined in the <strong>Content</strong> field in the Meta tag record.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the page. This value is read-only.</td>
</tr>
<tr>
<td>Metatag</td>
<td>The meta tag to apply the dynamic variable to.</td>
</tr>
<tr>
<td>URL query parameter</td>
<td>URL parameter to indicate the record that is being displayed. You can enter any string.</td>
</tr>
</tbody>
</table>

   **Tip:** To create a URL parameter that is meaningful and easily identifiable, use a field name from the record. For example, to refer to a knowledge article, you can enter `number` to reference the article by its number.

   Relevant table column | Table field to match the URL query parameter. For example, if you entered `number` to reference a knowledge article by its number, select **Number**. If left blank, the system uses the record `sys_id`.
   Table                | The source table of the URL query parameter record.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table field</td>
<td>Select a field from the table defined in the <strong>Table</strong> field. This field is used to generate the value of the content tag.</td>
</tr>
</tbody>
</table>

**Important:** To support SEO, ensure that the referenced table field is public. For more information on granting access to a table field, see Create an ACL rule.

If more than one content variables match a variable defined in the **Content** field of the meta tag record, the record with the earliest Created date is used.

d) Click **Submit**.
The content tag loads record data. For example:

```
<meta name="description" content="Apple iPad 3">
```

**Add dynamic titles to a page**

Create variables to generate descriptive titles depending on the content loaded into a page.

Role required: admin
Note: The dynamic titles don’t apply to the knowledge article view page in the Knowledge Management Service Portal.

1. Navigate to Service Portal > Pages.
2. Open a page.
3. Add one or more variables to the Dynamic page title field.

Depending on the available URL parameters and the dynamic title you would like to define, you can add the following types of values:

<table>
<thead>
<tr>
<th>Value types</th>
<th>Description</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>One URL parameter variable</td>
<td>Generates a page title using the associated record of one URL parameter.</td>
<td>%first_name</td>
</tr>
<tr>
<td>More than one URL parameter variable</td>
<td>Generates a page title using the associated records of multiple URL parameters.</td>
<td>%first_name %last_name</td>
</tr>
<tr>
<td>Value types</td>
<td>Description</td>
<td>Example value</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Static value and a URL parameter variable</td>
<td>Generates a page title using a static value and the associated record of a URL parameter.</td>
<td>Employee: %first_name</td>
</tr>
</tbody>
</table>

Enter the variables in the intended syntax of the title. For example, to have an employee's name and title separated by a hyphen, you would enter %first_name - %title.
In the page title, this syntax would render as something like "Beth - System Administrator".
4. Click the **Dynamic page title variables** related list tab.
5. Click **New** to create a new variable.
6. On the form, fill in the fields.

   Associate a field with a URL query parameter. When the value of the query parameter is used to display content, a field from the same record is used to generate the title. You can define the field to generate the title through the **Table field** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Variable to store the value. Must begin with <code>%</code> and cannot contain spaces. This value must match one of the variables defined in the <strong>Dynamic page title</strong> field.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the page. This value is read-only.</td>
</tr>
<tr>
<td>Page</td>
<td>Page to apply the dynamic variable to.</td>
</tr>
<tr>
<td>URL query parameter</td>
<td>URL parameter to indicate the record that is being displayed. You can enter any string.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> To create a URL parameter that is meaningful and easily identifiable, use a field name from the record. For example, to refer to a knowledge article, you can enter <strong>number</strong> to reference the article by its number.</td>
</tr>
<tr>
<td>Relevant table column</td>
<td>Table field to match the URL query parameter. For example, if you entered <strong>number</strong> to reference a knowledge article by its number, select <strong>Number</strong>. If left blank, the system uses the record sys_id.</td>
</tr>
<tr>
<td>Table</td>
<td>The source table of the URL query parameter record.</td>
</tr>
</tbody>
</table>
If more than one dynamic page variables match a variable defined in the **Dynamic page title** field, the record with the latest Updated date is used.

In this example, the value of the Question field in the Social Q&A Question table populates the page title. The `%question` variable must also be defined in the **Dynamic page title** field in the page record.

7. **Click Submit.**

When the page loads, the record defined in the URL query parameter displays. The field defined in **Table field** determines the title of the page.

**Page navigation by URL**

You can navigate to a portal or a page using the URL.

A Service Portal URL contains the following elements.

```
https://<base instance url>/<sp url suffix>?id=<page id>&<page parameters>
```
ServiceNow

DocVersion

Now Platform capabilities

Element

Description

Base Instance URL

Unique, secure web address for each instance. The default format is:

sp url suffix

Suffix established for the Service Portal. For example /sp.

id

The id of the Page to navigate to within the portal frame. For example, ?
id=index.

page parameters

Some pages require additional parameters to look up a record (table,
sys_id). Find the $sp.getParameter calls in a widget server script to
see what parameters a widget uses. For more detail on this method see
GlideSPScriptable - Scoped

For example, https://<instance name>.service-now.com/sp?id=kb_view2
Note: If you use article versioning with the Knowledge Management - Service Portal
(com.snc.knowledge_serviceportal) plugin enabled, you must add the article version number
to the URL to open a knowledge article in the base system or knowledge portals. For
example, instead of accessing an article using the URL https://<instance name>/sp?
id=kb_article&sys_id=KB0000005, you must include the article version number: https://
<instance name>/sp?id=kb_article&sys_id=KB0000005%20V1.0. To learn more, see
Article versioning.

Referencing a page id
Widgets and widget instance options reference Service Portal pages using the page id. For example, a link
to the sc_home page within a widget HTML template might appear as:
<div><a href="?id=sc_home">${Order something...}</a></div>

Redirect a reference to a page ID
Multiple widgets in the Service Portal may link to a single page using a hard-coded page ID. If you want
to replace the page, all widgets that reference the page must be updated with the new page ID. Instead of
cloning and updating each widget with the new page ID, you can create a single record that automatically
redirects all references to the original page to point to the new page. This way, you can replace a page
without locating and replacing all references to the page ID.
Role required: sp_admin
To redirect all references to a page, create a record in the Page Route Maps table [sp_page_route_map].
This table enables you to redirect a reference to a page without cloning base system widgets.
Creating a record in the Page Route Maps table only redirects references to a page. It does not redirect
navigation to a page ID within a URL.
Note: You don't need to create a page route map to redirect users to a 404 page. To specify the
404 page for your portal, update the 404 page field in the Portal [sp_portal] record.
1.
2.

Navigate to Service Portal > Page Route Maps.
Click New.

©

2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States
and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3345


3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Optional short description to describe the redirect.</td>
</tr>
<tr>
<td>Service Portal(s)</td>
<td>Portals that apply the redirect. If you don't select a portal, the redirect applies to all portals in the instance.</td>
</tr>
<tr>
<td>Route from</td>
<td>Original page you are redirecting from.</td>
</tr>
<tr>
<td>Route to</td>
<td>Page you are redirecting to.</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the Page Route Map record is active. The redirect only applies when the record is active.</td>
</tr>
<tr>
<td>Order</td>
<td>Priority of the Page Route Map record. If more than one active record has the same value in the Route from field, the record with the lowest order applies. The system evaluates records from lowest to highest. If multiple records have a matching order, the system honors the oldest record.</td>
</tr>
</tbody>
</table>

4. Click Update.

All references to the page listed in the Route from field redirect to the page in the Route to field.

Activate the Knowledge Article View page on upgrade

If upgrading from a previous release, take advantage of the latest article view features by activating the Knowledge Article View page route map. This map routes the kb_article page to the kb_article_view page, which includes new capabilities such as including links and images in article feedback and article versioning. This map is active by default in new instances and applies to all portals in the system.

Role required: admin

By default, users with the public role cannot access the kb_article_view page. However, your administrator can modify this behavior. For more information, see Enable external or public users to view knowledge articles from the Knowledge Management Service Portal.

After activating the Knowledge Article View page route map, you can:

- Comment on a knowledge article
- Create an article version by importing a Word document
- Create a version of a knowledge article from a managed document

1. Navigate to Service Portal > Page Route Maps.
2. Open the Knowledge Article View record.
3. Select Active.
4. Click Update.

Your end users view knowledge articles in the Service Portal using the kb_article_view page.
Create An Email Signature

To create a personalized email signature:

1. Open a new message. On the Message tab, in the Include group, click Signature, and then click Signatures.
2. On the E-mail Signature tab, click New.
3. Type a name for the signature, and then click OK.
4. In the Edit signature box, type the text that you want to include in the signature.
5. To format the text, select the text, and then use the style and formatting buttons to select the options that you want.
6. To add elements besides text, click where you want the element to appear, and then do any of the following:

<table>
<thead>
<tr>
<th>Options</th>
<th>How to</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add an electronic business card</td>
<td>Click Business Card, and then click a contact in the Filed As list. Then click OK</td>
</tr>
<tr>
<td>To add a hyperlink</td>
<td>Click Insert Hyperlink, type in the information or browse to a hyperlink, click to select it, and then click OK</td>
</tr>
<tr>
<td>To add a picture</td>
<td>Click Picture, browse to a picture, click to select it, and then click OK. Common image file formats for pictures include .bmp, .gif, .jpg, and .png.</td>
</tr>
</tbody>
</table>

1. To finish creating the signature, click OK.

NOTE:
The signature that you just created or modified won’t appear in the currently open message; it must be inserted into the message.
Include font icons on a page

Include font icons on a page so that all the widgets on the page have access to the font-icon set.

1. In the platform UI, navigate to Service Portal > Pages and click the page you want to add font icons to.
2. Attach the font-icon file to the page record.
3. In the Page Specific CSS field for the page, add the CSS for the font-icon definition. Use the sys_id of the attachment as the `src` in the CSS.

```css
@font-face {
  font-family: 'Material Icons';
  font-style: normal;
  font-weight: 400;
  src: url('/42aed5e64fddd3008a959a2113107c7\\e0b1f');
}

.material-ic...
Source code

<p style="text-align: center;"><em class="material-icons">flight_land</em></p>
Service Portal widgets

Widgets are what define the content in your portal. You can use the base system widgets provided with Service Portal, clone and modify widgets, or develop custom widgets to fit your own needs.

Base system widgets are read-only so you can benefit from future updates. To make changes, you can clone base system widgets. However, cloned widgets are considered custom and don't benefit from future updates to the widgets they were cloned from.

Widget library

Widgets included with Service Portal can be customized to suit your own needs or as a basic code sample for you to refer to as you are building your own widgets.

Note: Base system widgets are read-only so you can benefit from future updates. To make changes, you can clone base system widgets. However, cloned widgets are considered custom and don't benefit from future updates to the widgets they were cloned from.

Due to the ever-changing number of widgets that exist at any given time in Service Portal, this is not a definitive list. More widget descriptions will be added as they become available.

Depending on your configuration, widgets that do not contain any information do not appear in your Service Portal page.

To view the instance options for a widget, use the widget context menu.

Example widgets
- Announcements widget
- Approvals widget
- Approval Info widget
- Approval Record widget
- Breadcrumbs widget
- Breakout Game widget
- Calculator widget
- Carousel widget
- Cool Clock widget
- Header menu widget
- Hello World widgets
- HTML widget
- Icon Link widget
- Icon menu list widget
- Language Switch widget
- Link button widget
- Login widget
- My Requests widget
- Organization Chart widget
- Sample Footer widget
- Ticket Attachments widget
- Ticket Conversations widget
- Ticket Fields widget
- Ticket Location widget
- User Profile widget

Service Catalog widgets
- Catalog Content widget
- Catalog Homepage Search widget
- Recent & Popular Items widget
- Request Fields widget
- Requested Items widget
- Requests and Approvals widget
- SC Catalog Item widget
- SC Categories widget
- SC Category Page widget
- SC Order Guide widget
- SC Popular Items widget
- SC Save Bundles widget
- SC Saved Carts widget
- SC Scroll to top widget
- SC Shopping Cart widget
- SP Variable Editor widget
- SC Wish List Cart widget

Knowledge Management widgets
- KB also in Category widget
- KB Article Comments widget
- KB Article Page widget
- KB Categories widget
- KB Category Page widget
- KB Knowledge Bases widget
- KB Most Viewed widget
- KB News widget
- KB Search widget
- KB Top Rated widget
- KB View widget
- KB View 2 widget
- Knowledge Breadcrumbs widget
- My Favorite Tags widget
- Popular Questions widget
- SQANDA Create Question widget
- SQANDA Question widget
- SQANDA Related Question widget
- Subscribed Questions widget
- Tagged Question List widget
Service Status widgets
- Business Service Status widget
- Current Status widget
- Planned Maintenance widget
- Service History widget
- Service Status widget
- Service Status Legend widget
- Service Status Subscription widget

Service Portal configuration widgets
- Service Portal Config Overview widget
- Portal config widget
- SP Page Map widget
- SP Portal Map widget
- Theme Preview widget
- Widget Edit Panel widget

List and form widgets
- Simple List widget
- Data table from instance definition widget
- Data Table from URL definition widget
- Form widget

Search widgets
- Contextual Search widget
- Faceted Search widget
- Homepage Search widget
- Typeahead Search widget
- Legacy: Search Page widget

Example widgets

All widgets in Service Portal can be used as example code for how scripts are used in a widget. However, several base system widgets have been included expressly for this purpose.

Use the example widgets to see how to use HTML, CSS, or client and server scripts in Service Portal. You can also clone and extend each widget to suit your needs.

Announcements widget
Users can view all active announcements. You can use this base system widget as-is in your or clone it to suit your own business needs.

Announcements widget
Instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select the type of announcements to display. Announcement types can be selected in the announcement record. Choices include:</td>
</tr>
<tr>
<td></td>
<td>• Banner</td>
</tr>
<tr>
<td></td>
<td>• Widget</td>
</tr>
<tr>
<td></td>
<td>If a type is not defined, the widget instance displays all active announcements.</td>
</tr>
<tr>
<td>Title</td>
<td>Widget header title.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Glyph displayed to the left of the title.</td>
</tr>
<tr>
<td>Use Display Style</td>
<td>If selected, each announcement displays according to the style defined in the announcement record. Before selecting this option, consider how the widget will display if multiple announcements in the widget use different styles.</td>
</tr>
<tr>
<td>Paginate</td>
<td>Paginates multiple announcements.</td>
</tr>
<tr>
<td>Max Records</td>
<td>Number of announcements displayed per page.</td>
</tr>
<tr>
<td>View All Page</td>
<td>Click target for View all link. The View all link only displays when:</td>
</tr>
<tr>
<td></td>
<td>• There are more announcements than can be displayed on a single page. The Max Records field defines the number of records displayed per page.</td>
</tr>
<tr>
<td></td>
<td>• A view all page is defined.</td>
</tr>
<tr>
<td>Who Can View</td>
<td>Control who can and cannot view a widget instance with user criteria. Only visible if user criteria for the Service Portal is activated.</td>
</tr>
<tr>
<td>Instances</td>
<td>Who Cannot View Instances</td>
</tr>
</tbody>
</table>

Approvals widget
Users can approve or reject items directly within Service Portal. You can use this base system widget as-is in your or clone it to suit your own business needs.

Using the widget
The Approvals widget displays data from the Approvals [sysapproval_approver] table. If the user has been assigned to approve a request, the approval record is displayed in the widget.
You can enable e-signature for the approvals widget to require re-authentication for your users. For more information on enabling e-signature, see Enable e-signature for Service Portal.

**Instance options**

Use the instance options to change the appearance of the approvals widget.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Add an icon to display beside the widget name.</td>
</tr>
<tr>
<td>Buttons stacked side by side</td>
<td>If this check box is selected, the Approve and Reject buttons appear horizontally beside each other. If this check box is cleared, the Approve and Reject buttons appear stacked vertically.</td>
</tr>
<tr>
<td>Max number of elements shown in the list</td>
<td>Limit the number of approvals users see on a page. The default number is 10. Only enter numbers greater than 0.</td>
</tr>
<tr>
<td>Who can view instances/who cannot view instances</td>
<td>Control who can or cannot view a widget instance with user criteria. User criteria must be enabled for this option to appear.</td>
</tr>
</tbody>
</table>
**Approval Info widget**

The Approval Info widget works in tandem with the Approval widget to display details about the approval request. You can use this base system widget as-is in your or clone it to suit your own business needs.

### Instance options

**Approval info widget instance options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
</tbody>
</table>

**Approval Record widget**

The Approval Record widget shows the full record for an approval including the activity stream. You can use this base system widget as-is in your or clone it to suit your own business needs.
Approval Record widget

Instance options

The approval record widget does not include instance options.
Breadcrumbs widget

The breadcrumbs widget allows users to easily navigate around a portal. You can use this base system widget as-is in your or clone it to suit your own business needs.

Using the widget

The breadcrumbs widget displays information based on where a page is located in a portal. For example, if you navigate to the Knowledge Base from the home page, then the breadcrumb reads as Home > Knowledge Base. Each subsequent page that you open expands the breadcrumb.

Click a page name on the breadcrumbs widget to navigate to that page. For example, to return to the home page, click Home.

You can customize this widget to change the breadcrumb path. For more information, see KB0719179.

Instance options

The breadcrumbs widget does not have instance options.

Breakout Game widget

Add a fun, interactive 404 page to pages that do not exist using the Breakout Game widget. You can use this base system widget as-is in your or clone it to suit your own business needs.
Breakout Game widget

Instance options

The Breakout Game does not have instance option. You can use it as an example of how to use the Link Function as part of an Angular Directive.

Calculator widget

The calculator widget does simple calculations. You can use this base system widget as-is in your or clone it to suit your own business needs.

Use the calculator widget as an example of how to pass data between the client and server.
Calculator widget

Instance options

The calculator widget does not include instance options.

Carousel widget

Showcase specific items in your catalog using a scrolling list of images in the carousel widget. You can use this base system widget as-is in your or clone it to suit your own business needs.

Use the carousel widget to showcase items on your portal page. For example, display items available in a service catalog at the top of the service catalog page.
Carousel widget

Add slides to the carousel widget

Use the related lists for an instance of the carousel widget to add images for the carousel widget to scroll through.

Role required: Admin or sp_admin

1. Navigate to **Service Portal > Widgets**.
2. Open the **Carousel** widget record.
3. From the carousel form, on the **Instances** related list, under instances, open a carousel instance.
4. From the instance of carousel form, click **New** on the **Carousel Slides** related list.
5. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the carousel slide. Use the name to differentiate the slide from other slide records.</td>
</tr>
<tr>
<td>Order</td>
<td>Where the slide appears in the list of slides.</td>
</tr>
<tr>
<td>HREF/URL</td>
<td>Link to the item in the slide. For example, for a slide with a catalog item, link to page for the catalog item using the HREF ?id=&lt;page name&gt;&amp;sys_id=&lt;sys_id for item&gt;. For more information on linking to a page within a portal, see Page navigation by URL. You can also link to other sites using the URL.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Background</td>
<td>Upload an image for the slides. Carousel images should be 1022x300 pixels.</td>
</tr>
<tr>
<td>Application</td>
<td>Automatically populated with the name of the application the portal falls under.</td>
</tr>
<tr>
<td>Carousel</td>
<td>Name of the instance of the carousel widget you are adding the slide to. This field is not automatically populated and you cannot select an instance of the carousel widget if it does not have a name.</td>
</tr>
</tbody>
</table>

Repeat this step for as many slides as you want to appear in the carousel widget.

*Change Password widget*

Users can change their passwords using the Change Password widget.

Note: Updated credentials are stored in the User [sys_user] record in the local instance.
Instance Options

The Change Password widget does not have instance options.

Cool Clock widget
Show different times around the world using the Cool Clock widget. You can use this base system widget as-is in your or clone it to suit your own business needs.

Cool clocks demonstrates how to use instance options in a widgets. The time zone is loaded using an instance option. If you do not select a time zone, the widget uses a default time zone.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the clock, for example New York, NY. The name appears below the clock so it helps to use a name related to the time zone.</td>
</tr>
<tr>
<td>Timezone</td>
<td>The location from which the time is displayed. Use the local full name, for example, America/New York, instead of the abbreviated time zone. Using the full name allows time zones to stay consistent with daylight savings time. The default value is America/Los Angeles</td>
</tr>
</tbody>
</table>
### Field: Second hand color

Color of the second hand using the hex code, RGB, or color name. The default value is red.

---

**Data table from instance definition widget**

Display a filtered list on your portal using the data table from instance definition widget. You can use this base system widget as-is in your or clone it to suit your own business needs.

After you add the data table from instance definition widget to a page, use the instance options to configure the appearance of the table.

![Data table from instance definition widget](image)

**Instance options**

**Data table instance options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title of the widget. If you leave this field empty the name of the table displays as the widget name.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table</td>
<td>The table that the widget displays records from.</td>
</tr>
<tr>
<td>Filter</td>
<td>Text field from the condition builder that you can use to limit the items returned in the table. To create a filter, use the context menu to open the widget instance in the platform. Then use the condition builder to create a filter.</td>
</tr>
<tr>
<td>Maximum entries</td>
<td>Limits the number of items displayed in the table. If there are more entries than allowed in the table, users can scroll to the next page.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon that displays beside the widget title</td>
</tr>
<tr>
<td>Fields</td>
<td>Columns to display in the table.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Link to this page</td>
<td>Direct users to a specific page when they click a record. By default, clicking an entry in the table opens that entry in a form.</td>
</tr>
</tbody>
</table>

**Data Table from URL definition widget**

The Data Table from URL definition widget displays the table you select from the list. You can use this base system widget as-is in your or clone it to suit your own business needs.

**Instance options**

Complete the instance options to define the table.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title of the widget. Select the <strong>Use Instance Title</strong> check box to use this title instead of the name of the table.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon that displays beside the widget title</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Link to this page</td>
<td>Direct users to a specific page when they click a record. By default, clicking an entry in the table opens that entry in a form.</td>
</tr>
<tr>
<td>Fields</td>
<td>Columns to display in the table. For example, short description or priority.</td>
</tr>
<tr>
<td>Use Instance Title</td>
<td>Select to use the title in the Title field instead of the table title</td>
</tr>
<tr>
<td>Enable Filter</td>
<td>Select this check box to allow users to create their own filter for the table</td>
</tr>
</tbody>
</table>

If **Enable filter** is enabled in the instance options, users can add custom conditions to filter the results.
Data Table URL with condition builder

For more information on using the condition builder, see #unique_2901.

**Note:** The condition builder is only available in the desktop view.

**Form widget**
The form widget is a platform form within the Service Portal UI with a few differences. You can use this base system widget as-is in your or clone it to suit your own business needs.
Form widget

URL Parameters

The form widget accepts the following parameters within the URL.

Form widget URL parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_id or sl_sys_id</td>
<td>Sys_id for the record to be displayed</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>table, sl_table, or t</td>
<td>Table for the record to be displayed</td>
</tr>
<tr>
<td>view or v</td>
<td>View used to display the record</td>
</tr>
</tbody>
</table>

In the following example, the URL would display an incident with a sys_id of 1c741bd70b2322007518478d83673af3 in the portal view.

https://example.service-now.com/sp?id=form&table=incident&sys_id=1c741bd70b2322007518478d83673af3&view=portal

**Scripting**

Not all client scripts are supported in the Service Portal. To understand how client scripts interact with forms in the Service Portal, see Service Portal and client scripts and Supported client script types and APIs.

*Header menu widget*

The Header Menu widget controls which options appear in the page header. You can use this base system widget as-is in your or clone it to suit your own business needs.

Unlike other widgets in Service Portal, the header menu widget is not something you drag onto a page. Instead you configure the header menu by associating the header menu with a portal. For more information on configuring a header menu, see Configure a portal header menu.

**Header Menu widget**

**Instance options**

The header menu widget does not include instance options.

*Hello World widgets*

The Hello World widgets are included with Service Portal as examples of how to use and create widgets. You can use this base system widget as-is in your or clone it to suit your own business needs.

All three Hello World widgets display the same way. The real difference between them is in their underlying code base. Each version of the widget uses a different method of using the server and client script.

To view the Hello World widgets, navigate to Service Portal > Service Portal Configuration then click Widget Editor. In the Widget Editor, click Check out the Hello World Example.
Hello World 1

Hello world 1 displays how the HTML template and the client script communicate. For more information on using the client script in Service Portal, see Widget developer guide.

Use the widget list to switch to Hello World 2 or 3.
Hello World 2

Hello World 2 includes an example of how the server script can be used as well.
Hello World 3

For more information on Service Portal APIs, see the GlideSPSriptable API.

**HTML widget**

Use the HTML widget to directly inject HTML, text, lists, or content in general into a page. You can use this base system widget as-is in your page or clone it to suit your own business needs.

Because the HTML widget can contain content of any kind, any example may just appear as regular text. For example, the HTML widget appears as a box of text on the 404 page.
Sorry, the page you requested was not found.
This page you were trying to reach at this address doesn’t seem to exist. This is usually the result of a bad or outdated link. We apologize for any inconvenience.
While you are here, see if you can beat the "404" in a game of Breakout.

HTML widget

**Instance options**

**HTML widget instance options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name for the HTML text. Users do not see this information.</td>
</tr>
<tr>
<td>HTML</td>
<td>Text box for the HTML. Use the toolbar like most word processing tool bars. For more information on using the toolbar, see <a href="#">Formatting icons for the HTML field editors</a>.</td>
</tr>
</tbody>
</table>

**Icon Link widget**

Link to any other item. You can use this base system widget as-is in your or clone it to suit your own business needs.

Configure Icon Link widgets to link to a specific URL, page within the portal, or a specific category in the knowledge base or the service catalog.
Instance options

Instance options fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td>Name of the icon link. Choose something that defines what the widget is linking to.</td>
</tr>
<tr>
<td><strong>Glyph</strong></td>
<td>Icon for the widget.</td>
</tr>
<tr>
<td><strong>Bootstrap class name</strong></td>
<td>Use concurrently with page or theme level CSS.</td>
</tr>
</tbody>
</table>
| **Type**            | Defines what the widget links to. The fields that appear on the form vary depending on which option you select. Choose from:  
  • Page: Another page in the Service Portal  
  • URL: Link to an external website.  
  • Catalog category: Link to a specific catalog category within the service catalog.  
  • Catalog item: Link to a specific catalog item.  
  • KB topic: Link to a KB topic page.  
  • KB article: Link to a KB article by number.  
  • KB category: Link to a specific KB category within the knowledge base. |
| **Page**            | Page within the portal that you want to link to. This field varies depending on the Type you choose. |
| **Bootstrap color** | Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list. |
| **Template**        | The appearance of the link icon widget. Choose from:  
  • Top icon  
  • Circle icon  
  • Color box |

Icon menu list widget

A simple list with a glyph icon next to each link. You can use this base system widget as-is in your or clone it to suit your own business needs.

Configure the icon information using the Menu Items related list.
Icon Menu list widget

1. From the instance options for the icon menu list widget, under Related Lists, click **Menu Items**.
2. Click **New**.
3. Use the fields on the New Menu Items form to configure the icons for the icon menu list widget.

### Icon menu list widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name or description of the icon</td>
</tr>
<tr>
<td>Parent Menu</td>
<td>The name of the menu that the icon appears in. This automatically populates with the name of the icon menu list widget that you created but you have the option to switch it to another menu.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the icons appear in the icon menu list widget.</td>
</tr>
<tr>
<td>Parent menu Item</td>
<td>Nest menu items within a parent menu.</td>
</tr>
<tr>
<td>Page</td>
<td>The page within Service Portal that the icon links to. Select <strong>Page</strong> from the Type list to enable this option.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of link you want the icon to have. You can link to pages within Service Portal, external URLs, KB articles, Service Catalog, or lists. Different fields will appear on the form depending on the option you select from the list.</td>
</tr>
<tr>
<td>Condition</td>
<td>Determines what conditions are required for menu items to show in the header. For more information on what conditions to use in the <strong>Condition</strong> field, see <strong>Create a UI Action #unique_2902</strong>.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon that you want to display in the icon menu list widget.</td>
</tr>
</tbody>
</table>

**Language Switch widget**

Add the Language Switch widget to a landing or homepage to allow your users to change the language of the page. You can use this base system widget as-is in your or clone it to suit your own business needs.
Language Switch widget

Instance options

The Language Switch widget does not include any instance options.

Link button widget

The Link Button widget is a button you can nest in any other widget that links to another destination. You can use this base system widget as-is in your site or clone it to suit your own business needs.

Link Button widget

Instance options

Instance option fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Link for button</td>
<td>Page that the button links to. Use ?id=&lt;page_name&gt; to link to another page in the portal.</td>
</tr>
<tr>
<td>Contents of button</td>
<td>The button text.</td>
</tr>
</tbody>
</table>

Login widget

The login widget controls user access to your site. You can use this base system widget as-is in your site or clone it to suit your own business needs.
The login widget by default includes a **Forgot Password?** link that enables users to reset their password using the Password Reset application. For more information about Password Reset configuration, see **Password Reset application**.

**Note:** When the user clicks **Forgot Password?**, the system redirects the user to the page value specified in the `glide.security.password_reset.uri` system property.

If you do not want to include the **Forgot Password?** link, set the `glide.security.forgot_password.display.link` system property to false.

**Login widget**

**Instance options**

**Instance options fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show panel</td>
<td>Show or hide the panel that appears behind the login widget. The panel helps the widget stand out from the page background rather than blending in.</td>
</tr>
<tr>
<td>Use Advanced View</td>
<td>Changes the widget layout. Adds the <strong>Forgot Password?</strong> link to the left of the <strong>Login</strong> button and adds field names for <strong>User name</strong> and <strong>Password</strong> instead of hint text.</td>
</tr>
</tbody>
</table>

**My Requests widget**

The My Requests widget stores all of your open requests in one place. You can use this base system widget as-is in your or clone it to suit your own business needs.

The list is updated in real time so you can see your requests getting processed. The widget pulls open request information from the `sc_request` table.
My Requests widget

Instance options

<table>
<thead>
<tr>
<th>Title</th>
<th>Requests</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Default</td>
</tr>
<tr>
<td>Maximum entries</td>
<td></td>
</tr>
</tbody>
</table>

My Requests widget instance options

Instance options fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the widget. The name you enter here appears in the header for the widget.</td>
</tr>
</tbody>
</table>
### My Requests widget

Use the My Requests widget (my-requests-v2) to enable requesters to view open or closed requests in Service Portal. Requests, incidents, and tasks are displayed in a single view that is based on the filter conditions and display settings in the My Request Filter module. For information on defining filters for this module, refer to the Related information section.

### Instance options

Use the widget instance options to customize the settings for the My Requests widget. To customize the settings for this widget, press the Ctrl key, click on the widget, and select Instance Options.

#### Instance options for the My Requests widget

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Title of the widget.</td>
</tr>
<tr>
<td>Behavior</td>
<td></td>
</tr>
<tr>
<td>Show View</td>
<td>If selected, displays the View list. Using this list you can filter for closed or open requests. If deselected, only open requests are displayed.</td>
</tr>
<tr>
<td>Items per page</td>
<td>Number of records displayed per page.</td>
</tr>
</tbody>
</table>

Enable the My Requests menu for an upgrade scenario

Enable the My Requests menu that uses the My Requests (my-requests-v2) widget for an upgrade scenario.

**Role required: admin**

The My Requests menu that is based on the My Requests (my-requests-v2) widget is available by default for zBoot users. For more information about this widget, refer to My Requests widget.

1. Navigate to Service Portal > Portals.
2. Select a portal.
3. Next to the Main menu field, click Preview this record and open the record.
4. In the Menu items related list, perform the following steps.
   a) For the Requests menu item of the Page type, set Active as true.
   b) For the Requests menu item of the Scripted List type, set Active as false.

5. Navigate to Service Portal > Page Route Maps.
6. For the My Request page route map, set Active as true.
7. Click **Update**.

**Organization Chart widget**
The Organization Chart widget shows employees in a tree structure relative to their manager. You can use this base system widget as-is in your或其他clone it to suit your own business needs.

**Using the widget**

In the text input field, enter or select a user to see their manager and subordinates. The widget uses information from the User [sys_user] record to display the organization hierarchy relative to the selected user.
Bud Richman
Sales
bud.richman@example.com
4492 Camino De La Plaza, San Ysidro, CA

David Loo
Development
david.loo@example.com
153 South Sierra Avenue, Solana Beach, CA

Alissa Mountjoy
Product Management
alissa.mountjoy@example.com
Bockenheimer Landstraße 223, Frankfurt
Click a card to open the profile page for that user. To reconfigure the card link, change the **URL** or **Page** in the widget instance options.

You can drag individual cards to rearrange the chart.

You can zoom in or out of the chart view by clicking the magnifying glass icons or by scrolling.

**Instance options**

Use the instance options to configure the Organization Chart widget for a portal page.

*Note:* There are no valid values for several instance options. By default, you can set only the following instance options:
- User Background Color
- Node Background Color
- URL
- Page

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Fields from the user record that appear on each card. By default, each card</td>
</tr>
<tr>
<td></td>
<td>displays the name, title, department, email, phone, and location of each</td>
</tr>
<tr>
<td></td>
<td>user. <strong>There are no valid values that you can enter in this field.</strong></td>
</tr>
<tr>
<td>Card Fields</td>
<td></td>
</tr>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User Background Color</td>
<td>Color of the user card. Use color names or Hex codes. For example, you can enter red or #ff0000.</td>
</tr>
</tbody>
</table>

The user background color is **lightblue** by default.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Background Color</td>
<td>Color of cards that extend from the user card. Use color names or Hex codes. For example, you can enter yellow or #ffff00.</td>
</tr>
<tr>
<td></td>
<td>The node background color is <strong>azure</strong> by default.</td>
</tr>
<tr>
<td>Table Layout</td>
<td>Size and margin of the content in each card. There are no valid values that you can enter in this field.</td>
</tr>
<tr>
<td>Row Layout</td>
<td>Alignment of the text in the card. The text is left-aligned by default. There are no valid values that you can enter in this field.</td>
</tr>
<tr>
<td>Line</td>
<td>Color of the lines that connect cards. The lines are black by default. There are no valid values that you can enter in this field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Tree Layout</td>
<td>Size, spacing, and alignment of the chart.</td>
</tr>
<tr>
<td></td>
<td><strong>There are no valid values that you can enter in this field.</strong></td>
</tr>
<tr>
<td>Picture Layout</td>
<td>Size of image space in each card. By default, the image space is 55x65 pixels. The user image is shrunk or stretched to fit the space.</td>
</tr>
<tr>
<td></td>
<td><strong>There are no valid values that you can enter in this field.</strong></td>
</tr>
<tr>
<td>Behavior</td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td>Web address of the page that opens when you click a card. Use the part of the portal URL that references the page ID. For example, to navigate to the Service Catalog, enter ?id=sc_category. If left blank, clicking the card opens the page that is specified in the Page field. If the Page field is also blank, clicking the card opens the user profile page by default.</td>
</tr>
<tr>
<td>Page</td>
<td>Portal page that opens when you click a card. Use the page ID. If left blank, clicking the card opens the web address in the URL field. If the URL field is also blank, clicking the card opens the user profile page by default.</td>
</tr>
</tbody>
</table>

Note: The URL field overwrites the Page field. To specify a page rather than a URL, leave the URL field blank.

**Simple List widget**

The Simple List widget can be used to display any list in the system within Service Portal. You can use this base system widget as-is in your or clone it to suit your own business needs.
My Open Incidents

InsideSales NeuralView Instance relocation from US datacenter to Hong Kong dat...
INC0006789 • a day

Results not as per expectation after performing the documented steps in Oracle...
INC0006911 • a day

Performance degrade observed in Oracle Planning and Budgeting
INC0006890 • a day

Network response time is poor
INC0006800 • a day

Performance degrade observed in Eloqua Marketing Measurement
INC0006790 • a day

Fidelity Stock Plan Services upgrade to the latest version
INC0006797 • a day

Simple List widget

Instance options

Instance options fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The platform table that the simple list is formed from.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display field</td>
<td>Main field that displays as the &quot;title&quot; of the list item.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon that displays next to the widget name in the header.</td>
</tr>
<tr>
<td>Filter</td>
<td>Conditions that are applied to the list. To edit the filter, in the widget instance options context menu, select <strong>Open in platform</strong>. Use the Table &amp; Filter tab to apply conditions to the simple list. For more information, see #unique_2901.</td>
</tr>
<tr>
<td>Link to this page</td>
<td>Portal page to link to from a list item.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Bootstrap size</td>
<td>Size of the widget</td>
</tr>
<tr>
<td>Maximum entries</td>
<td>Maximum allowed number of entries that appear in the list at one time.</td>
</tr>
<tr>
<td>Show even when empty</td>
<td>Widgets are designed to hide on a page when no results meet the criteria. Select this option to make the simple list widget display on a page even when empty.</td>
</tr>
<tr>
<td>List body height</td>
<td>Actual length of the widget in pixels or EMs. A long list with a small body height includes a scroll bar option.</td>
</tr>
<tr>
<td>Image field</td>
<td>Displays an image in the list. Select a field type that includes an image. For example, Photo.</td>
</tr>
<tr>
<td>Secondary fields</td>
<td>Fields from the list item that display in addition to the main display field.</td>
</tr>
<tr>
<td>Rounded images</td>
<td>Makes any images selected in the Image field round in the list.</td>
</tr>
<tr>
<td>List page</td>
<td>The page that opens when a user selects <strong>View all</strong> in the widget footer. Select a page that correlates with the items that display in the list.</td>
</tr>
<tr>
<td>Hide footer</td>
<td>Show or hide the widget footer</td>
</tr>
<tr>
<td>View</td>
<td>The view option for when a list item links to a form. The <strong>Link to this page</strong> field must be set to a form page for this option to work.</td>
</tr>
</tbody>
</table>

**Sample Footer widget**
The Sample Footer widget is an example of a footer you can use in your portal. You can use this base system widget as-is in your or clone it to suit your own business needs.

Unlike other widgets in Service Portal, you add a footer to your portal by configuring it in the Theme form. For more information on adding a footer to a portal, see Add a header or footer to a portal.
Sample Footer widget

**Instance options**

The Sample footer widget does not include instance options.

**Ticket Attachments widget**

Use the attachment widget to attach items to tickets. You can use this base system widget as-is in your or clone it to suit your own business needs.

Attachments should be less than 24MB. You can drag files into the Attachments widget to add them to a record.

<table>
<thead>
<tr>
<th>Attachments</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Drop files here" /></td>
</tr>
</tbody>
</table>

**Ticket Attachments widget**

**Instance options**

**Ticket attachments widget instance options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record ID</td>
<td>The ID number of the record for the attachment.</td>
</tr>
<tr>
<td>Record table</td>
<td>Limit the records users can add an attachment to by adding a table to the attachment widget. Users can then only add attachments if they are in a record for that table.</td>
</tr>
</tbody>
</table>

**Ticket Conversations widget**

Record of ticket items. Users can use this widget to communicate back and forth with the fulfiller and the receiver. You can use this base system widget as-is in your or clone it to suit your own business needs.

The Ticket Conversations widget displays journal entries from the activity formatter of the target record. Journal entries are presented in chronological order, with the oldest entries appearing at the bottom of the
widget. Entries made by the user that created the record appear on the right side of the center divider. Entries made by other users appear to the left.

The Ticket Conversations widget is intended only for tables that extend task.

Limit the number of journal entries that appears in the ticket conversation widget using the `glide.service_portal.stream_entry_limit` system property. The default number is 100. Change the number by navigating to Service Portal > Properties, and enter the new number in the Maximum number of stream entries displayed in Service Portal field.
### Instance options

#### Instance options fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use dynamic placeholder</td>
<td>Use a placeholder for journal fields. The default value is false.</td>
</tr>
<tr>
<td>No readable journal field message</td>
<td>The message that displays when there are no readable journal fields. Forms that have added journal fields may not display in the Ticket Conversation widget.</td>
</tr>
</tbody>
</table>

#### Ticket Fields widget

The Ticket Fields widget displays information about a request that a user has made. You can use this base system widget as-is in your or clone it to suit your own business needs.

#### Using the widget

After a user submits a request, they can track their request on a ticket page in Service Portal. The user can consult the Ticket Fields widget to review the details of their request and check its resolution status.
Your request has been submitted

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>RITM0010001</td>
</tr>
<tr>
<td>State</td>
<td>Open</td>
</tr>
<tr>
<td>Priority</td>
<td>4 - Low</td>
</tr>
<tr>
<td>Created</td>
<td>about an hour ago</td>
</tr>
<tr>
<td>Updated</td>
<td>about an hour ago</td>
</tr>
<tr>
<td>Price</td>
<td>$600.00</td>
</tr>
<tr>
<td>Quantity</td>
<td>1</td>
</tr>
</tbody>
</table>

Tickets are picked up within 4 hours (M-F 9-5)

Fields for the Ticket Fields widget are defined by the HTML template and the server.

If a user entered variables when submitting the request, they can view those variables in the Options section.
**Options**

- **I agree to the term**
  - false

- **desktop**
  - false

- **explorers**
  - false

---

**Note:** The values that appear in the Options section are not field values from the ticket. They are Service Catalog variables that are associated with the ticket. For more information, see Service catalog variables.

---

**Instance options**

Use the instance options to configure the Ticket Fields widget for a portal page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pickup message</td>
<td>Text to communicate the expected resolution time of the ticket. This text is displayed below the ticket fields. The default is ${Tickets are picked up within &lt;br/&gt; 4 hours (M-F \ 9-5)}. Ensure that any changes you make are within the curly braces.</td>
</tr>
</tbody>
</table>

**Ticket Location widget**

Share your location in a ticket. You can use this base system widget as-is in your or clone it to suit your own business needs.
The Ticket Location widget does not include any instance options.

**User Profile widget**
Display user profile information. You can use this base system widget as-is in your or clone it to suit your own business needs.

Users can use the User Preferences section to enable accessibility in a portal.
User Profile widget

Instance options

The User Profile widget does not include instance options.

Search widgets

Several search widgets are provided with Service Portal.

You can configure search in Service Portal using any of the search widgets.

*Contextual Search widget*

Contextual Search is an embedded widget that can be added to a record producer. You can use this base system widget as-is in your or clone it to suit your own business needs.
By default, the widget is included in the **Create Incident** record producer form to display items based on keywords entered in the description. These items can be knowledge articles, service catalog items, and social Q&A records. These search results appear as the user types the information.

*Please describe your issue below*

```
email
```

The more information you can provide here, the easier the time the support organization will have in diagnosing and resolving your incident.

### Search Results

**Deleted Email Recovery**

Deleted **Email Recovery** by default, every **email** deleted from your OWA mailbox goes through the following process: The **email** is moved to your Deleted Items folder. If you purge or remove items from the Dumpster only holds **email** message for 14 days once they’ve been removed from Deleted Items. Deleted...

Author: Ron Kettering • 9 views • ☆ ☆ ☆ ☆

**What is Spam?**

**IT | Email**

receives some spam, **email** addresses posted to web sites or in newsgroups and chat rooms attract the most spam. ‘Definitions The term “spam” is Internet slang that refers to unsolicited commercial **email** (UCE) or unsolicited bulk **email** (UBE). Some people refer to this kind of communication as junk **email**...

Author: Ron Kettering • 9 views • ☆ ☆ ☆ ☆ ☆

### Contextual Search widget

**Faceted Search widget**

The Faceted Search widget displays search results and search facets defined for a search source. The Faceted Search widget enables end users to filter search results for a more meaningful result set.
Faceted Search widget

**Faceted Search instance options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facet List Title</td>
<td>Display title for the facet component.</td>
</tr>
<tr>
<td>Typeahead Search - Title</td>
<td>Default text in the typeahead search component.</td>
</tr>
<tr>
<td>Typeahead Search - Color</td>
<td>Whether the glyph in the typeahead component is filled in.</td>
</tr>
<tr>
<td>Typeahead Search - Glyph</td>
<td>Icon that appears in the search field beside the widget. The search icon is the default. The to use a different icon, type the name of the icon in the field, for example search-plus. For a list of icons to choose from, open the instance options for the Icon Link widget.</td>
</tr>
<tr>
<td>Typeahead Search - Size</td>
<td>Determines the font size and height of the widget. Choose from xs, sm, md, and lg.</td>
</tr>
<tr>
<td>Max results for All search</td>
<td>Maximum number of results that display for all search sources when viewed together.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Max results for single search source</td>
<td>Maximum number of results that display for a single search source.</td>
</tr>
<tr>
<td>Show Did You Mean</td>
<td>Displays suggestions when a search produces no results.</td>
</tr>
<tr>
<td>Typeahead Search - Limit</td>
<td>Number of typeahead search results displayed. The default is 15.</td>
</tr>
</tbody>
</table>

For more information on configuring search, see Service Portal search.

**Homepage Search widget**

Add a search bar to your home page. You can use this base system widget as-is in your or clone it to suit your own business needs.

Configure your own search sources to constrain what topics appear on search, or just use the default search sources. For more information on configuring search, see Service Portal search.
Homepage Search widget

Instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name that appears above the search bar. For example &quot;How can we help?&quot;</td>
</tr>
<tr>
<td>Short description</td>
<td>A subtitle that appears below the title.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Typeahead search</td>
<td>Controls the appearance of the search bar. Use a comma separated list inside curly braces to add style details to the search bar, for example (title: 'Search', color: 'blue', size: 'lg'). For more information on which style options you can add, see the instance options for the Typeahead Search widget.</td>
</tr>
</tbody>
</table>

**Legacy: Search Page widget**

The Search Page widget displays search results. The Faceted Search widget replaces the Search Page widget. You can use this base system widget as-is in your or clone it to suit your own business needs.
Search results for 'email'

 Deleted Email Recovery

Deleted Email Recovery By default, every email deleted from your OWA mailbox goes through the following process: The email is moved to your Deleted Items folder. If you purge or remove items from your

Article: KB0000030 · Published: 3y ago

What is Spam?

What is Spam? Spam has increasingly become a problem on the Internet. While every Internet user receives some spam, email addresses posted to web sites or in newsgroups and chat rooms attract the most

Article: KB0000029 · Published: 3y ago

How to Deal with Spam

How to Deal with Spam Spam has increasingly become a problem on the Internet. While every Internet user receives some spam, email addresses posted to web sites or in newsgroups and chat rooms attract the

Article: KB0000011 · Published: 3y ago

What are phishing scams and how can I avoid them?

Phishing explained Phishing explained Phishing scams are typically fraudulent email messages appearing to come from legitimate enterprises (e.g., your company, your Internet service provider, your bank

Article: KB0000028 · Published: 3y ago
Search Page instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show score</td>
<td>When selected, shows search results relative to ranking.</td>
</tr>
<tr>
<td>Max results for All search</td>
<td>The maximum number of results that show for all search groups when viewed together.</td>
</tr>
<tr>
<td>Max results for single search group</td>
<td>The maximum number of results that show for a single search group when you view that specific search group.</td>
</tr>
<tr>
<td>Show Did You Mean</td>
<td>Displays suggestions when a search produces no results.</td>
</tr>
</tbody>
</table>

For more information on configuring search, see Service Portal search.

**Typeahead Search widget**

Predictive search feature that shows words as users type. You can use this base system widget as-is in your or clone it to suit your own business needs.
Typeahead Search widget

Typeahead search instance options
### Instance option fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The name or words that appear in the search field before a user starts typing. For example, search or what are you looking for</td>
</tr>
<tr>
<td>Color</td>
<td>Whether the search button beside the search field is filled in or not</td>
</tr>
<tr>
<td>Glyph</td>
<td>The icon that appears in the search field beside the widget. The search icon is the default. To use a different icon, type the name of the icon in the field, for example search-plus. For a list of icons to choose from, open the instance options for the Icon Link widget.</td>
</tr>
<tr>
<td>Size</td>
<td>Determines the font size and height of the widget. Choose from xs, sm, md, and lg.</td>
</tr>
<tr>
<td>Limit</td>
<td>If search suggestions is enabled, enter the number of suggestion entries you want to display. If search suggestions is disabled, enter the number of typeahead entries you want to display. The default is 15. See Enable and disable search suggestions.</td>
</tr>
<tr>
<td>Contextual Search Sources</td>
<td>Limit the results available in the typeahead search by only configuring specific search sources. For example, users searching in the Service Catalog only see results for the Service Catalog when that search sources is configure. For more information on contextual search, see Configure Search Sources available on a page</td>
</tr>
</tbody>
</table>

### Knowledge Management widgets

Use Knowledge Management widgets to build a knowledge base for your portal.

Knowledge Management widgets are included as part of the Service Portal - knowledge base plugin [com.glide.service-portal.knowledge-base], which is activated automatically with the Service Portal for Enterprise Service Management [com.glide.service-portal.esm] plugin.

For more information on knowledge management, see Knowledge Management.

**KB also in Category widget**

List of articles also included within a particular category. You can use this base system widget as-is in your or clone it to suit your own business needs.

The information that appears in the KB also in Category widget is determined by the knowledge article child categories. For more information, see Define a knowledge article category.
ServiceNow DocVersion Now Platform capabilities

Also in Windows

What is the Windows key?
How to set or change your default web browser
How can I restore my computer to a previous configuration?

KB also in Category widget

Instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
</tbody>
</table>

KB also in Category instance options

Instance Options

KB Article Comments widget
Rating and comment option for knowledge base articles. You can use this base system widget as-is in your or clone it to suit your own business needs.

Ratings on articles in the KB Article Comments widget determine the article popularity in the KB top rated widget.
KB Article Comments widget

Instance Options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show star rating</td>
<td>Select the option to show a star rating on the KB article comments widget. Selecting the Use system properties option shows the star rating option based on the glide.knowman.show_star_rating system property.</td>
</tr>
<tr>
<td>Show user comments</td>
<td>Select the option to show the comment box on the KB article comments widget. Selecting the Use system properties option shows the comment box based on the glide.knowman.show_user_feedback system property.</td>
</tr>
</tbody>
</table>

KB Article Page widget

Use the Article page widget to view Knowledge Base articles within Service Portal. You can use this base system widget as-is in your or clone it to suit your own business needs.

Any specialized font or formatting added in the text field for the knowledge article within the platform, appears the same way in the portal.
Getting Around in Windows

Windows 8.x

Windows 8.x is designed for using touch, mouse, and keyboard together, on hardware ranging from touch-enabled tablets and laptops to PCs and all-in-one computers, including those without touch capability.

Start screen and Desktop

- 8.1: Microsoft updated the Windows 8.1 interface by returning the Start button, providing its ease of access along with the option of the Metro interface. The intent is to provide a seamless experience on desktops, laptops, tablets, and phone devices. By default, the Start screen is displayed. Move your mouse pointer to the bottom left corner of the screen to make the Start button appear. Click it to display the desktop; click it again to display the Start screen.

- 8: The Start screen has a default application display you can customize:
  1. Right-click any app and the Application bar will appear at the bottom, with options for the application you have selected.
  2. To add an app to the Start screen, click Pin to Start.
    If an application is already on the Start screen, you'll see Unpin from Start instead.

Power User menu

The Power User menu displays the most commonly used applications from the Control Panel, File Explorer, and Task Manager, as well as Restart, Run, Search, and Shutdown/Update. Access it in one of the following ways:

- Press Win + X
Instance Options

KB article page widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Show star rating</td>
<td>Displays the star rating on the article page widget. If you select <strong>Use system properties</strong>, the appearance of the star rating is defined by the <strong>glide.knowman.show_star_rating</strong> system property.</td>
</tr>
</tbody>
</table>

**KB Categories widget**

Lists the categories for your Knowledge Base. You can use this base system widget as-is in your or clone it to suit your own business needs.
Categories are determined by the list of Knowledge Categories provided for the Knowledge Base. To view a list of categories for a knowledge base, in the platform navigate to Knowledge > Administration > Knowledge bases, then select the name of the knowledge base, for example IT. Categories for the knowledge base appear in the related lists. If a category does not have any associated articles, it does not appear in the portal. For more information on defining categories for a knowledge base, see Define a knowledge article category.

The knowledge base that a portal uses is determined in the portal form. If your portal uses multiple knowledge bases, you can use the KB Knowledge Bases widget to filter the content of the KB Categories widget.

For more information on associating your portal with a knowledge base, see Associate a portal with a knowledge base.

Instance options

The KB categories widget does not include instance options.
**KB Category Page widget**

Articles and article preview within a particular category. Categories are specified within the Knowledge Base module. You can use this base system widget as-is in your or clone it to suit your own business needs.

The KB Category Page widget works together with the KB Categories widget. When you select a category in the KB Categories widget, the KB Category page widget lists articles within that category.

To have the KB Categories and KB Category Page widgets work in tandem, add the two widgets to the same page.
Are Copyrighted Files Illegal to Have On My Computer?
Are Copyrighted Files Illegal to Have On My Computer? Tools built to make use of the Internet easier have created special concern for the holders of copyright. While it takes time and energy for someone to photocopy all the
Author by Wayne Webb • 5y ago

Dealing with Spyware and Viruses
Dealing with Spyware/Adware Spyware is the generic term for computer software that gathers information about you and your Internet surfing habits for marketing purposes; Adware refers to programs which gather information
Author by Wayne Webb • 5y ago

What is a cookie?
What is a cookie? Cookies are messages that web servers pass to your web browser when you visit Internet sites. Your browser stores each message in a small file, called cookie.txt. When you request another page from the server,
Author by Wayne Webb • 5y ago

Getting Around in Windows
Getting Around in Windows Windows 8.x Windows 8.x is designed for using touch, mouse, and keyboard together, on hardware ranging from touch-enabled tablets and laptops to PCs and all-in-one computers, including those
Author by System Administrator • 4y ago • ✔️

Sales Force Automation is DOWN
On Friday, January 20th, we experienced a widespread outage that affected all Zoho services. The outage started around 8:13 am Pacific Time. Zoho services started coming back online for customer use at 3:49 pm, and all
Author by Wayne Webb • 5d ago
If you add the KB Category Page widget to a page without adding the KB Categories widget, the KB Category Page widget displays an uncategorized list of all articles within the knowledge base.

Categories are determined by the list of Knowledge Categories provided for the Knowledge Base. To view a list of categories for a knowledge base, in the platform navigate to Knowledge > Administration > Knowledge bases, then select the name of the knowledge base, for example IT. Categories for the knowledge base appear in the related lists. If a category does not have any associated articles, it does not appear in the portal. For more information on defining categories for a knowledge base, see Define a knowledge article category.

The knowledge base that a portal uses is determined in the portal form. For more information on associating your portal with a knowledge base, see Associate a portal with a knowledge base.

**Instance options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Show star rating</td>
<td>Displays the star rating on the category page. If you select Use system properties, the appearance of the star rating is defined by the glide.knowman.show_star_rating system property.</td>
</tr>
</tbody>
</table>

**KB Knowledge Bases widget**

Give users the option to select which knowledge base to browse on your portal. You can use this base system widget as-is in your or clone it to suit your own business needs.
Using the widget

If you associate your portal with multiple knowledge bases, the KB Knowledge Bases widget provides users with a menu to select a knowledge base. After a user selects a knowledge base, other KB widgets on the page filter their content accordingly.

For example, if a user selects to browse only the IT knowledge base, then the KB Categories widget shows only the categories within the IT knowledge base.

If you associate your portal with only one knowledge base, then the KB Knowledge Bases widget remains hidden on the page.

For more information on associating your portal with knowledge bases, see Associate a portal with a knowledge base.

Instance options

The KB Knowledge Bases widget doesn't include instance options.

KB Most Viewed widget
List of most viewed knowledge base articles, based on user feedback. You can use this base system widget as-is in your or clone it to suit your own business needs.
KB Most Viewed widget

Instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The name that appears in the widget header</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Max number</td>
<td>The maximum number of most viewed articles listed</td>
</tr>
<tr>
<td>KB category</td>
<td>KB category for the most viewed articles. The list is generated by the kb_category table.</td>
</tr>
</tbody>
</table>

*KB News widget*

The KB News widget displays information from the Knowledge Base. You can use this base system widget as-is in your or clone it to suit your own business needs.

You can configure the KB News widget to display specific information by selecting a category from the KB category list.

![KB News widget](image-url)
Instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the widget that appears in the widget header</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Max number</td>
<td>The maximum number of news articles appearing in the widget. The default number is 5.</td>
</tr>
<tr>
<td>KB category</td>
<td>The knowledge base category determined by the kb_category table. Only published articles display. For a news widget, select something like Announcements to show upcoming events.</td>
</tr>
</tbody>
</table>

KB Search widget
The KB Search widget is a search widget that is specifically confined to the knowledge base. You can use this base system widget as-is in your or clone it to suit your own business needs.

The typeahead search widget is embedded in the KB search widget.
KB Search widget

Instance options

KB search widget instance options
ServiceNow    DocVersion    Now Platform capabilities

Instance option fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the widget. This field is non-public facing.</td>
</tr>
</tbody>
</table>

**KB Top Rated widget**

Lists Knowledge Base articles with the highest rating. Ratings are determined by user feedback. You can use this base system widget as-is in your or clone it to suit your own business needs.

---

**Top Rated Articles**

**Eclipse configuration for Java development**

⭐⭐⭐⭐⭐

---

**KB Top Rated widget**

**Instance options**

**KB top rated widget instance options**

**Instance options fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The name that appears in the widget header</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Max number</td>
<td>The maximum number of most viewed articles listed</td>
</tr>
<tr>
<td>KB category</td>
<td>KB category for the top rated articles. The list is generated by the kb_category table.</td>
</tr>
</tbody>
</table>

**KB View widget**

The KB View widget is an example of how to structure a knowledge base page. You can use this base system widget as-is in your or clone it to suit your own business needs.

Use the search filter to find a specific topic or article.
Instance options

The KB view widget does not have any included instance options.
KB View 2 widget

The KB View 2 provides an alternative structure to the KB View widget to show a different example of how to display knowledge articles. You can use this base system widget as-is in your or clone it to suit your own business needs.

The KB View 2 widget displays each knowledge category as a card. Click a card to access the articles within that category.

**IT**

- **Applications**
  - 3 articles

- **Devices**
  - 1 article

- **Email**
  - 8 articles

- **IT**
  - 7 articles

- **Operating Systems**
  - 12 articles

- **Suppliers**
  - 1 article

KB View 2

Categories are determined by the list of Knowledge Categories provided for the Knowledge Base. To view a list of categories for a knowledge base, in the platform navigate to **Knowledge > Administration > Knowledge bases**, then select the name of the knowledge base, for example IT. Categories for the knowledge base appear in the related lists. If a category does not have any associated articles, it does not appear in the portal. For more information on defining categories for a knowledge base, see **Define a knowledge article category**.

The knowledge base that a portal uses is determined in the portal form. For more information on associating your portal with a knowledge base, see **Associate a portal with a knowledge base**.

**Instance options**

The KB View 2 widget does not have any included instance options.

**Knowledge Breadcrumbs widget**

Help users navigate a knowledge base by adding the Knowledge Breadcrumbs widget. You can use this base system widget as-is in your or clone it to suit your own business needs.
Using the widget

The knowledge breadcrumbs widget displays information based on where an article is located in a knowledge base. For example, if you open an article on "How to Deal with Spam," the breadcrumbs show that the article is located in the Email category of the IT knowledge base.

You can broaden your search of the knowledge case by clicking the titles in the breadcrumbs. For example, to see all articles in the Email category, you would click Email. To see all articles in the knowledge base, you would click IT (Knowledge Base).

Instance options

The Knowledge Breadcrumbs widget does not have instance options.

My Favorite Tags widget

The My Favorite Tags widget allows you to follow specific questions based on the tags. By saving favorite tags, you can see questions that are specific to that tag. You can use this base system widget as-is in your or clone it to suit your own business needs.

Instance options

The My Favorite Tags widget does not have any included instance options.
**Popular Questions widget**
List of popular questions asked in the community. You can use this base system widget as-is in your or clone it to suit your own business needs.

<table>
<thead>
<tr>
<th>Question</th>
<th>Author</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>What's the best way to find meeting rooms in the office?</td>
<td>Joe Employee</td>
<td>4mo ago</td>
</tr>
<tr>
<td>What is the process for getting company approved banners and images?</td>
<td>Abel Tuter</td>
<td>4mo ago</td>
</tr>
<tr>
<td>What are the pros and cons between OSX and Windows machines?</td>
<td>Joe Employee</td>
<td>4mo ago</td>
</tr>
<tr>
<td>How do you install the wireless printer on OSX?</td>
<td>Adela Cervantsz</td>
<td>4mo ago</td>
</tr>
<tr>
<td>Where is tipping expected? Is that a business expense?</td>
<td>Beth Anglin</td>
<td>4mo ago</td>
</tr>
</tbody>
</table>

**Instance options**

The Popular Questions widget does not have any included instance options.

**SQANDA Create Question widget**
Type your own question. Add a tag for better searchability. You can use this base system widget as-is in your or clone it to suit your own business needs.
Social Q&A Create Question widget

Instance options

The SQANDA Create Question widget does not have any included instance options.

SQANDA Question widget
Use the Social Q&A question widget to view and respond to questions. You can use this base system widget as-is in your or clone it to suit your own business needs.
Has anyone tried ordering accessories that are not listed on the catalog?

I want to order an ergonomic mouse but everything in the company catalog is pretty basic. Can I just order one online and expense it if it's the same price?

4mo ago • Asked by Abel Tutor

1 Answer

0

You can always consult with your manager and they may be already on the approved list of accessories. You can also submit a request and we'll let you know if you should order it and expense it.

4mo ago • Answered by System Administrator

SQANDA Question widget
Instance options

The SQANDA Question widget does not have any included instance options.

SQANDA Related Question widget
Lists statistics about a question as well as recently asked questions. You can use this base system widget as-is in your or clone it to suit your own business needs.
The SQANDA Related Questions widget does not have any included instance options.
**Subscribed Questions widget**
The Subscribed Questions widget allows you to see questions you have subscribed to. You can use this base system widget as-is in your or clone it to suit your own business needs.

You can subscribed to questions other people have asked by selecting the star icon underneath the question.

![My Subscribed Questions](image)

**Instance options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
</tbody>
</table>

**Tagged Question List widget**
List of questions sortable by tag, time it was asked, top rated, and unanswered. You can use this base system widget as-is in your or clone it to suit your own business needs.

The Tagged Questions List widget generates the list based on tags that users have applied to questions.
Newest Questions

1. **Does anyone know a good template for work email signature?**
   - I've been looking at different emails and everyone has their own signature. Does anyone have a standard or a good template use in my email?
   - **Answer:** marketing, email
   - **Votes:** 2
   - **4mo ago - Mara Rineheart**

2. **What's the best way to find meeting rooms in the office?**
   - How are the conference rooms named in the headquarters office? Is there an easy way to find which floor and side of the office a room is located?
   - **Answers:** office, meeting, facilities
   - **Votes:** 2
   - **4mo ago - Joe Employee**

3. **What are the pros and cons between OSX and Windows machines?**
   - I know this can be a just matter of preference but I want to make sure I know as much as possible about the pros and cons of the two operating system, since I have to live with it for the next three years.
   - **Answers:** windows, Laptop, OSX
   - **Votes:** 3
   - **4mo ago - Joe Employee**

4. **Any suggestions on using the company credit card?**
   - I just received my company credit card in mail. Before I start expensing work related purchases, I want to know about what can be considered a "company expense".
   - **Answers:** expenses, company card
   - **Votes:** 1
   - **4mo ago - Joe Employee**

---

Tagged Question List widget
Instance options

The SQANDA Tagged Question List widget does not have any included instance options.

Service Catalog widgets

Use the Service Catalog widgets to build a catalog for your portal.

Most service catalog widgets are part of the Service Portal Service Catalog [com.glide.service-portal.service-catalog] plugin that is activated automatically with the Service Portal for Enterprise Service Management (com.glide.service-portal.esm) plugin.

The Service Portal - Service Catalog v2 plugin (com.glideapp.servicecatalog.portal) provides an enhanced Service Catalog experience. This plugin is active by default and enables the following widgets:

- Catalog Homepage Search (ID: cat-homepage-search)
- SC Scroll to top (ID: sc-scroll-to-top)
- Requests and Approvals (ID: sc_request_and_approvals)
- Recent & Popular Items (ID: sc-recent-popular)

Most of the configuration for the Service Catalog widgets takes place in the Service Catalog application of the platform. For more information on Service Catalog, see Service Catalog.

Catalog Content widget

The Catalog Content widget is part of the Service Catalog and includes a tiled list of all the content items available in the catalog. You can use this base system widget as-is in your or clone it to suit your own business needs.

The items that appear on the page are grouped by category alphabetically. Catalog items and categories are defined in the Service Catalog application in the platform. For more information on creating catalog items to appear in the catalog, see Create a catalog item.
Catalog Content widget

Instance Options

The Catalog Content widget does not include instance options.

Catalog Homepage Search widget
Give your users the option to search the Service Catalog as soon as they log in. You can use this base system widget as-is in your or clone it to suit your own business needs.

Using the widget
Add the Catalog Homepage Search widget on your Service Catalog landing page. When users navigate to the Service Catalog, they can use the Catalog Homepage Search widget to find what they are looking for.
Users can enter a keyword in the search bar. The Catalog Homepage Search widget uses a predictive search feature that shows words as users type.

Alternatively, to navigate to a list of Service Catalog categories, users can select **Browse by Categories**.

### Instance options

Use the instance options to configure the Catalog Homepage Search widget for a portal page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Presentation</strong></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Title to appear above the search bar.</td>
</tr>
<tr>
<td>Short description</td>
<td>Text to appear under the title.</td>
</tr>
<tr>
<td><strong>Other Options</strong></td>
<td></td>
</tr>
<tr>
<td>Typeahead Search</td>
<td>Configuration of the search bar. You configure the search bar by using the instance options for the <strong>Typeahead Search widget</strong>. Use the syntax <code>{field1:'value1',field2:'value2'}</code>. For example, to configure the title, color, and size of the search bar, enter the following: <code>{title:'Search...',color:'default',size:'lg'}</code>.</td>
</tr>
</tbody>
</table>

**Recent & Popular Items widget**

Allow a user to browse recent and popular catalog items. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
Using the widget

The Recent & Popular Items widget includes two tabs: My Recent Items and Popular Items.
A user opens the My Recent Items tab to see catalog items that they recently viewed or requested.

<table>
<thead>
<tr>
<th>My Recent Items</th>
<th>Popular Items</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Google Nexus 7</strong></td>
<td><strong>Google Droid Razr Maxx</strong></td>
</tr>
<tr>
<td>Google Nexus 7</td>
<td>Motorola Droid Razr Maxx 2</td>
</tr>
<tr>
<td>View Details</td>
<td>View Details</td>
</tr>
<tr>
<td>$199.99</td>
<td>$99.99</td>
</tr>
<tr>
<td><strong>Brother Network-Ready Color Laser Printer</strong></td>
<td><strong>Canon imageCLASS LBP-6550DN Laser Printer</strong></td>
</tr>
<tr>
<td>View Details</td>
<td>View Details</td>
</tr>
<tr>
<td>$399.50</td>
<td>$499.99</td>
</tr>
<tr>
<td><strong>Telephone Extension</strong></td>
<td><strong>IP 560 Phone</strong></td>
</tr>
<tr>
<td>View Details</td>
<td>View Details</td>
</tr>
<tr>
<td>$195.00</td>
<td>$60.00</td>
</tr>
<tr>
<td><strong>Dreamweaver</strong></td>
<td><strong>Apple iPad 3</strong></td>
</tr>
<tr>
<td>View Details</td>
<td>View Details</td>
</tr>
<tr>
<td>$60.00</td>
<td>$600.00</td>
</tr>
</tbody>
</table>

A user opens the Popular Items tab to see catalog items that have been widely requested by other users.
Each item card displays basic information about the catalog item, such as the item name, image, and price. To navigate to the item listing, the user selects View Details.

### Instance options

Use the instance options to configure the Recent & Popular Items widget for a portal page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Popular Items used in</strong></td>
<td>Time span over which users have requested the popular items. You select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• -- None --: Display popular catalog items with no time span specified. This is the default option.</td>
</tr>
<tr>
<td></td>
<td>• Last 3 Months: Display the most requested catalog items in the past three months.</td>
</tr>
<tr>
<td></td>
<td>• Last 6 Months: Display the most requested catalog items in the past six months.</td>
</tr>
<tr>
<td></td>
<td>• Last 12 Months: Display the most requested catalog items in the past year.</td>
</tr>
<tr>
<td></td>
<td>• Life time (Has performance implications): Display the most requested catalog items of all time. Selecting this option may decrease system performance.</td>
</tr>
<tr>
<td><strong>Presentation</strong></td>
<td></td>
</tr>
<tr>
<td>Number of Items</td>
<td>Maximum number of catalog items to display in each tab. The value is 8 by default.</td>
</tr>
<tr>
<td><strong>Behavior</strong></td>
<td></td>
</tr>
<tr>
<td>My Recent Items By</td>
<td>Criteria to qualify which catalog items are displayed in the My Recent Items tab. You can select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• -- None --: Display recent items with no criteria specified. This is the default option.</td>
</tr>
<tr>
<td></td>
<td>• View: Display the catalog items that the user viewed most recently.</td>
</tr>
<tr>
<td></td>
<td>• Request: Display the catalog items that the user requested most recently.</td>
</tr>
</tbody>
</table>

*Request Fields widget*

The Request Fields widget displays information about any request a user has made. You can use this base system widget as-is in your or clone it to suit your own business needs.

Fields for the Request Fields widget are defined by the HTML template and the server.
Request Fields widget

Instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pickup message</td>
<td>Information that appears at the bottom of the widget. Make sure any changes you make are within the curly braces. The default is ${Requests are picked up within &lt;br/&gt; 4 hours (M-F 9-5)}</td>
</tr>
</tbody>
</table>

Requested Items widget

Describes at what stage of the order a requested item is. You can use this base system widget as-is in your or clone it to suit your own business needs.

You can define different workflows for items directly within the Service Catalog module. For more information on Service Catalog workflows, see Service Catalog request fulfillment.
Requested Items widget
Instance options

- Title: Requested Items
- Bootstrap color: Primary
- Display field: Short description
- Filter: 
- Table: Requested Item [sc_req_item]
- Link to this page: ticket
- Maximum entries: 20

Save (⌘ + s)
Requested Items instance options fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the widget. The title appears in the header of the widget.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Display field</td>
<td>Determine what information displays as the title for each requested item. Short description is the default.</td>
</tr>
<tr>
<td>Filter</td>
<td>Limit what appears in the list using a filter. You can add a filter by opening the Requested Items record in the platform (From the context menu, click <strong>Open in platform</strong>) and using the condition builder.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that displays the item when the user clicks an entry</td>
</tr>
<tr>
<td>Link to this page</td>
<td>Page that opens when the user clicks an item</td>
</tr>
<tr>
<td>Maximum entries</td>
<td>Max number of entries that appear in the list of requested items</td>
</tr>
</tbody>
</table>

*Requests and Approvals widget*

Allow a user to refer to their open requests and approvals in the Service Catalog. You can use this base system widget as-is in your or clone it to suit your own business needs.

*Using the widget*

The Requests and Approvals widgets includes two tabs: **My Requests** and **My Approvals**.

A user opens the My Requests tab to see data from the Task [task] table. If the user has opened any task record, such as an incident or a change request, the record is displayed in the widget.
A user opens the My Approvals tab to see data from the Approvals [sysapproval_approver] table. If the user has been assigned to approve a request, the approval record is displayed in the widget.
If the user doesn't have any open requests or approvals, the widget remains hidden on the page.

**Instance options**

The Requests and Approvals widget doesn't include instance options.

*SC Catalog Item widget*

Use this widget (widget-sc-cat-item-v2) to view the information about a catalog item and order the item. You can use this base system widget as-is in your or clone it to suit your own business needs.

Configure catalog items using the Service Catalog in the platform UI by navigating to **Service Catalog > Catalog Definitions > Maintain Items**.

Catalog variables determine what information your users are allowed to select from, for example, color, size, or price. For more information on defining the variables for a catalog item, see **Create a service catalog variable**.
Apple iPad 3

Apple iPad 3

iPad with Retina display Wi-Fi 16GB - Black

Key Features:
- Retina display (2048x1536 resolution)
- 16GB storage
- Wi-Fi enabled
- Built-in speaker, microphone and camera
- Up to 10 hours battery life

List Collector

Add attachments
Instance options

Use the widget instance options to customize the settings for the SC Catalog Item widget. To customize the settings for this widget, press the Ctrl key, click on the widget, and select Instance Options.

**Instance options for the SC Catalog Item widget**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color of the widget based on the selections made in the Branding Editor.</td>
</tr>
<tr>
<td>Other Options</td>
<td></td>
</tr>
<tr>
<td>Show Add Cart Button</td>
<td>Displays the Add to Cart button in the Order Item widget.</td>
</tr>
<tr>
<td>Show field validation messages</td>
<td>Displays the Required information section with mandatory fields whose values are not specified.</td>
</tr>
<tr>
<td>Show Add/Update Wish List buttons</td>
<td>Displays the Add to Wish List or the Update Wish List buttons in the Order Item widget.</td>
</tr>
<tr>
<td>Order Item Section on Top</td>
<td>Displays the Order Item widget to the right of the catalog item form. Else, the Order Item widget is displayed below the catalog item form.</td>
</tr>
</tbody>
</table>
| Enable Show More/Less for Item description on Mobile | Enables the Show more or Show less options for the catalog item description in the mobile view. By default, the Show more option is available.  
  - Click Show more to display the entire description.  
  - Click Show less to display only 150 characters of the description. |

**SC Categories widget**

The SC Categories widget displays Service Catalog categories. You can use this base system widget as-is in your or clone it to suit your own business needs.

The system renders the categories available in this widget from the Categories table in Service Catalog [sc_category].
If you associate your portal with multiple catalogs, then the SC Categories widget also includes a menu to select which catalog to browse.
For more information on associating your portal with catalogs, see Configure a catalog in Service Portal.

Instance options

Categories widget instance options fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Defines what page opens when a user clicks a category. By default, this option redirects to the page for the selected category.</td>
</tr>
<tr>
<td>Page</td>
<td>Specifies the number of categories displayed in the Categories pane. By default, ten categories are displayed. If there are additional categories, the Show All option is available.</td>
</tr>
<tr>
<td>Number of categories to load</td>
<td>Select a flat or nested layout. A flat layout shows all of the available categories. A nested layout shows only the parent categories. Use a nested layout if you have a large number of categories to prevent an unnecessarily long list. Click that appears next to a category with nested topics to expand the sub-categories. The widget only supports three levels of nesting. After level four, categories appear in the flat view.</td>
</tr>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td>Category Layout</td>
<td></td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Hide at XS | Hides the categories option on small screens, for example, on smart phones. The default is set to false.
Omit badges | Show or hide the number of items included in each category.
Check canView per item | Verifies with each item that the user has the right roles to view the catalog item.

**Note:** If a category contains more than 200 items, update the following instance options on this widget for better performance:
- Category Layout: Flat
- Omit badges: True
- Check canView per item: False

**SC Category Page widget**
Lists the catalog items available within a certain category. Categories are determined within the Service Catalog module. You can use this base system widget as-is in your or clone it to suit your own business needs.

**Note:** Catalog items are sorted in ascending order by their **Order** value. If catalog items have the same order, they are sorted by the **Name** field.
SC Category Page widget

Instance options

Category page widget instance options fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click event name</td>
<td>The name of the event that is emitted when a user clicks a catalog item.</td>
</tr>
<tr>
<td></td>
<td>You can override the default behavior when clicking on a catalog item by</td>
</tr>
<tr>
<td></td>
<td>providing a different event name.</td>
</tr>
<tr>
<td></td>
<td>This would be in a situation where you embedded the category page in another</td>
</tr>
<tr>
<td></td>
<td>widget.</td>
</tr>
<tr>
<td></td>
<td>The default value is $sp.cat_item_list.click.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Number of items to display per page</td>
<td>Number of items to display in the category page.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When defining the number of items to be displayed, consider the item data such as images and long descriptions. A large number may slow down the page performance.</td>
</tr>
<tr>
<td>Show items from Child Categories</td>
<td>Displays items in the child categories along with those in the parent category.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the Category Layout instance options is set to Flat in the SC Categories widget, then set this instance option to False.</td>
</tr>
</tbody>
</table>

**SC Order Guide widget**

Use this widget (widget-sc-order-guide-v2) to request an order guide, that is, a single service catalog request for several catalog items with a specific purpose. You can use this base system widget as-is in your or clone it to suit your own business needs.

Configure order guides using the Service Catalog in the platform UI by navigating to Service Catalog > Catalog Definitions > Order Guides.

The order guide form comprises the following sections:

### Describe Needs

This section displays the following that are associated with the order guide:

- Image
- Description
- Variables

### Choose Options

This section displays a list of catalog items included in the order guide based on the information provided in the Describe Needs section and the rule base configured for the order guide. Each catalog item is displayed with its name and description on an accordion.

Each accordion displays:

- **Options**, if a catalog item has fields that need user inputs.
  
  **Note:** If the fields are mandatory, a red asterisk is displayed beside Options.

- A toggle to include the catalog item in the order guide request. You can make it mandatory to include all items in the order guide request by not displaying the toggle. You can make it optional to include items in the order guide request by displaying the toggle. To display the toggle for each catalog item of the...
order guide, select the **Show Include Toggle (Service Portal)** check box while configuring the order guide. For more information, see Create an order guide.

**Note:** When an item is excluded from the order guide request, the item is not editable and the corresponding mandatory field restrictions are ignored.

### Summary

This section provides a summary of the order guide that you can review before requesting the order guide.

### Instance options

Use the widget instance options to customize the settings for the SC Order Guide widget. To customize the settings for this widget, press the Ctrl key, click on the widget, and select **Instance Options**.

#### Instance options for the SC Order Guide widget

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation</td>
<td>Name of the order guide.</td>
</tr>
<tr>
<td>Title</td>
<td>Color of the widget based on the selections made in the Branding Editor.</td>
</tr>
<tr>
<td>Bootstrap Color</td>
<td>Displays the widget in the compact mode when configured for smaller real estates (less than 6'6).</td>
</tr>
</tbody>
</table>
| Compact Mode                               | Enables the **Show more** or **Show less** options for the description of the order guide or the associated catalog items in the mobile view. By default, the **Show more** option is available.  
  - Click **Show more** to display the entire description.  
  - Click **Show less** to display only 150 characters of the description. |
| Enable Show More/Less for Item description on Mobile | This instance option is applicable for the description of the order guide in the Describe Needs section, and the description of the associated catalog items in the Choose Options section. |

**SC Popular Items widget**

List of Service Catalog items that users purchase often. You can use this base system widget as-is in your or clone it to suit your own business needs.
Popular Items

Apple iPad 3

Executive Desktop

View Details $600.00 View Details $1,875.00

SC Popular Items widget

Instance Options

Popular Items widget instance options

Popular Item widget instance option fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit</td>
<td>Maximum number of popular items shown. The default number is 9.</td>
</tr>
<tr>
<td>Include Record Producers</td>
<td>Includes requests made through record producers.</td>
</tr>
</tbody>
</table>

SC Save Bundles widget

The Save Bundles widget allows you to save specific catalog items together for reuse. You can use this base system widget as-is in your or clone it to suit your own business needs.
The Save Bundles widget is embedded within the SC Shopping Cart widget.

### Create New Bundle

Here, you can save the current contents of your cart as a bundle, which can be restored at any time.

To create a new bundle, provide a name for your bundle, select the items you would like to include in the bundle, and press save.

<table>
<thead>
<tr>
<th>Bundle Name</th>
<th>Product 1</th>
<th>Product 2</th>
<th>Product 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple iPhone 5</td>
<td>$599.99 + $31.00 Monthly</td>
<td>1</td>
<td>$599.99 + $31.00 Monthly</td>
</tr>
<tr>
<td>Logitech USB Headset for PC &amp; Mac</td>
<td>$29.99</td>
<td>1</td>
<td>$29.99</td>
</tr>
<tr>
<td>Sales Laptop</td>
<td>$1,100.00 + $100.00 Annually</td>
<td>1</td>
<td>$1,100.00 + $100.00 Annually</td>
</tr>
</tbody>
</table>

**SC Save Bundles widget**

### Instance Options

The Save Bundles widget does not have any included instance options.

**SC Saved Carts widget**

The Saved Carts widget shows previously created and saved bundles from the Service Catalog. You can use this base system widget as-is in your or clone it to suit your own business needs.
SC Saved Cart widget

When you add an existing cart bundle to a shopping cart, you have two options. You can:

- Replace the items in the shopping cart with the items in the bundle.
- Add the bundle in addition to the rest of the items in the cart.

**iPad + phone**

*Replace Cart* will remove the current contents of your cart and replace it with the bundle.

*Add to Cart* will add the contents of the bundle into your cart without removing its current contents.

**Items In Bundle**

<table>
<thead>
<tr>
<th>Item</th>
<th>Price</th>
<th>Quantity</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Google Nexus 7</td>
<td>$199.99</td>
<td>1</td>
<td>$199.99</td>
</tr>
<tr>
<td>Apple iPad 3</td>
<td>$600.00</td>
<td>1</td>
<td>$600.00</td>
</tr>
</tbody>
</table>

*Add bundle items to a cart*
Instance Options

The Saved Carts widget does not have any included instance options.

*SC Scroll to top widget*

In the Service Portal mobile view, the SC Scroll to top widget (sc_scroll_to_top) lets you scroll to the top of the screen after you scroll down. You can use this base system widget as-is in your or clone it to suit your own business needs.

This widget is displayed when you start to scroll upwards after reaching a specific screen height.
Sales Laptop
Acer Aspire NX

View Details $1,100.00

Test Order Guide

View Details

Create Incident
Create an Incident record to report and request assistance with an issue you are having

View Details
Instance options

Use the widget instance options to customize the settings for the SC Scroll to top widget. To customize the settings for this widget, press the Ctrl key, click on the widget, and select Instance Options.

<table>
<thead>
<tr>
<th>Height from top (px)</th>
<th>Screen height where the widget is displayed when you start to scroll upwards.</th>
</tr>
</thead>
</table>

SC Shopping Cart widget

The SC Shopping Cart widget (sc-shopping-cart-v2), used with Service Catalog, stores all your orders at one place. You can use this base system widget as-is in your or clone it to suit your own business needs.

Use the shopping cart widget to:

- Control the quantity of items in the cart.
- Add items to a cart. This information is stored in the sc_cart table.
- Define who the items are being requested for.
- Save specific items together as a bundle, which can be reloaded later. You can replace the cart items with the saved bundles, or add the bundles to the cart items.
- Remove all items from your cart.
Your Cart

<table>
<thead>
<tr>
<th>Item</th>
<th>Price</th>
<th>Quantity</th>
<th>Subtotal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple iPad 3</td>
<td>$600.00</td>
<td></td>
<td>$600.00</td>
</tr>
<tr>
<td>Standard Laptop</td>
<td>$1,100.00</td>
<td></td>
<td>$1,100.00</td>
</tr>
<tr>
<td></td>
<td>+ $100.00 Annually</td>
<td></td>
<td>+ $100.00 Annually</td>
</tr>
<tr>
<td><strong>Total price:</strong></td>
<td>$1,700.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>+ $100.00 Annually</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Continue Shopping  Save as Bundle  Clear Cart  Proceed to Checkout

My Saved Bundles

Bundle1  Remove  Open

SC Shopping Cart widget

Instance options

Use the widget instance options to customize the settings for the SC Shopping Cart widget. To customize the settings for this widget, press the Ctrl key, click on the widget, and select Instance Options.
Instance options for the SC Shopping Cart widget

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Presentation</strong></td>
<td></td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Color scheme for the widget. The default colors are defined by the portal theme, but if you want the instance to have a specific color, select the option from the list.</td>
</tr>
<tr>
<td><strong>Behavior</strong></td>
<td></td>
</tr>
<tr>
<td>Cart Template</td>
<td>Enter the name of a ng-template you want to use to provide a different template for the shopping cart. By default, two ng-templates are provided: small_shopping_cart_v2.html and large_shopping_cart_v2.html.</td>
</tr>
<tr>
<td>Auto update cart</td>
<td>Automatically updates the cart across all sessions.</td>
</tr>
</tbody>
</table>

Enable the Shopping Cart widget

The shopping cart widget is enabled automatically for instances upgrading to Istanbul, however, there are several ways to manually enable or disable the widget.

To enable the shopping cart for a catalog item:

1. Navigate to a catalog item on the Service Catalog page in Service Portal.
2. CTRL+right-click a catalog item widget to open the widget instance options.
3. Select or clear the **Show Add Cart Button** option to enable or disable the shopping cart for that particular catalog item.
Catalog item cart option

To enable the shopping cart in the portal header:

1. From the Service Portal configuration page, select the Portal editor.
2. Select the SP Header Menu in the portal hierarchy.
3. In the Additional options section, make sure the enable cart value is set to true.

```json
{   "enable_cart": {   "displayValue": "true",   "value": true  }
}
Set the value to `false` to hide the shopping cart.
Shopping cart in the header menu
Enable automatic updates to the shopping cart
Update the shopping cart automatically with user-specific changes from multiple tabs and platforms.

Role required: admin or sp_admin

1. Navigate to Service Portal > Service Portal Home. The Service Portal homepage is displayed.
2. In the banner, click Cart.
3. Press and hold the Ctrl key, click the wish list widget, and select Instance Options.
4. Select the Auto update cart check box and click Save.
5. Perform these steps only for upgrade customers.
   a) Navigate to Service Portal > Service Portal Configuration.
   b) In the banner, click Portals.
   c) In the list, ensure that Service Portal is selected.
   d) In the portal hierarchy chart, select SP Header Menu.
   e) In the Additional options, JSON format field, set the auto_update_cart value as true.

```
"auto_update_cart": {
    "displayValue": "true",
```
Automatic updates to the shopping cart
**SP Variable Editor widget**

The Variable Editor widget allows you to change the specifications you chose for an item in the Service Catalog. You can use this base system widget as-is in your or clone it to suit your own business needs.

You can embed the variable editor widget in the shopping cart widget, to allow users to edit and make changes to their cart items. The options included in the widget are determined by the specific catalog item and the variables that have been configured for it.

For more information on the service catalog variables that are available in Service Portal, see service catalog variable types.

### Variables

<table>
<thead>
<tr>
<th>Allocated carrier</th>
<th>Sprint Nextel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monthly data allowance</td>
<td>500MB [$1 Monthly]</td>
</tr>
<tr>
<td>Contract duration</td>
<td>12 Months</td>
</tr>
<tr>
<td>Color</td>
<td>Black</td>
</tr>
<tr>
<td>Storage</td>
<td>64GB</td>
</tr>
</tbody>
</table>

**Save**

---

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Instance Options

The Variable Editor widget is embedded as part of the shopping cart widget, therefore no instance options are included.

SC Wish List Cart widget
Use this widget to add catalog items or record producers to the wish list so that you can review them. You can use this base system widget as-is in your or clone it to suit your own business needs.

If the wish list is enabled for Service Catalog, SC Wish List Cart widget (sc_wishlist_cart) is available in Service Portal. Once enabled, the following options are available:

- The Wish List menu option on the main navigation bar.
- The Add to Wish List button in the Ordering widget for catalog items and record producers.
- A wish list details page that displays all items in the Wish List.

From the wish list details page, you can view or delete catalog items, clear the wish list, or navigate to the Service Catalog landing page.

SC Wish List Cart widget

Instance options

Use the widget instance options to customize the settings for the SC Wish List Cart widget. To customize the settings for this widget, press the Ctrl key, click on the widget, and select Instance Options.
Enable the SC Wish List Cart widget in Service Portal

Add catalog items or record producers to the wish list after you enable the wish list.

Role required: admin or sp_admin

1. Navigate to Service Catalog > Maintain Catalogs.
2. From the Catalogs list, select Service Catalog.
3. On the catalog form, select the Enable Wish List check box and click Update.

The Wish List menu option is displayed in the Service Portal banner.

Note: The Use the sc_layout driven cart macros (default true) (glide.sc.use_cart_layouts) property must be set to true to enable the wish list.

4. To enable the Wish List menu option in the Service Portal banner, perform these additional steps only for upgrade customers.
   a) Navigate to Service Portal > Service Portal Configuration.
   b) In the banner, click Portals.
   c) In the list, ensure that Service Portal is selected.
   d) In the portal hierarchy chart, select SP Header Menu.
   e) In the Additional options, JSON format field, set the enable_wishlist value as true.

   ```json
   "enable_wishlist": {
       "displayValue": "true",
   ```
ServiceNow

DocVersion

Now Platform capabilities

"value": true

Enable the SC Wish List Cart widget

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
5. Enable the Add to Wish List icon ( ), in the Ordering widget of a catalog item or record producer:

   a) Navigate to Service Portal > Service Portal Home > Order Something. The Service Portal homepage is displayed.
   b) Click one of the available catalog items.
   c) Press and hold the Ctrl key, click a catalog item widget, and select Instance Options.
   d) Select the Show Add/Update Wish List buttons check box and click Save.

Enable automatic updates to the wish list

Update the wish list automatically with user-specific changes from multiple tabs and platforms.

Role required: admin or sp_admin

1. Navigate to Service Portal > Service Portal Home. The Service Portal homepage is displayed.
2. Access the wish list.
3. Press and hold the Ctrl key, click the wish list widget, and select Instance Options.
4. Select the Auto update wish list check box and click Save.
5. Perform these additional steps only for upgrade customers.
   a) Navigate to Service Portal > Service Portal Configuration.
   b) In the banner, select Portals.
   c) In the list, ensure that Service Portal is selected.
   d) In the portal hierarchy chart, select SP Header Menu.
   e) In the Additional options, JSON format field, set the auto_update_wishlist value as true.

   "auto_update_wishlist": {
       "displayValue": "true",
   }
Automatic updates to the wish list

```json
{
  "auto_update_wishlist": {
    "displayValue": "true",
    "value": true
  }
}
```
Service Portal configuration page widgets

Service Portal uses widgets for configuration. When you configure a page or a widget for a portal in the Service Portal Configuration page, you actually use Service Portal widgets to do so.

Service Portal configuration widgets are internal only and cannot be extended.

Configuration page widgets are included as part of the Service Portal Configuration Pages plugin [com.glide.service-portal.config], which is activated automatically when you activate the Service Portal for Enterprise Service Management plugin [com.glide.service-portal.esm].

Navigate to Service Portal > Service Portal Configuration to view these widgets in action.

Service Portal Config Overview widget

The Service Portal Config Overview widget is the widget that appears on the sp_config homepage. Use this widget to navigate Service Portal Configuration. You can use this base system widget as-is in your or clone it to suit your own business needs.
Service Portal

Create rich, engaging and modern experiences to help your business run better
Select one of the options below to continue

- **Branding Editor**
  Customize your portal's title, logo and theme colors. Preview changes as you make them

- **Designer**
  Create and layout pages with drag-and-drop functionality. Preview pages as you make changes

- **Page Editor**
  Configure the properties of pages, containers and widgets from a map view

- **Widget Editor**
  Create widgets from scratch or customize an existing one. Write HTML, CSS, and Javascript with real-time preview

- **Get Help**
  Browse guides, tutorials and videos to learn how to set up, configure and customize your portals
**Portal config widget**
The Portal Config widget is the left panel of the Branding Editor, which you use to configure themes for your portal. You can use this base system widget as-is in your portal or clone it to suit your own business needs.
Quick Setup

Title and Logo

Portal title

Service Portal

Logo

Logo Padding

Left:

Right:

Top:

Use title and logo to represent your brand across all pages of a portal

Tag Line and Background
**SP Page Map widget**
The Page Map widget works in the Page Editor to display any Service Portal page in a tree structure. You can use this base system widget as-is in your or clone it to suit your own business needs.

**SP Portal Map widget**
The Portal Map widget displays your portal in a tree structure. You can use this base system widget as-is in your or clone it to suit your own business needs.

**Theme Preview widget**
The Theme Preview widget appears in the Branding Editor and allows you to see any theme changes you make to your portal. You can use this base system widget as-is in your or clone it to suit your own business needs.
Theme Preview

Navbar

Brand

Text Primary - Nullam id dolor id nibh ultricies vehicula ut id elit.
Text Success - Duis mollis, est non commodo luctus, nisi erat porttitor ligula.
Text Info - Maecenas sed diam eget risus varius blandit sit amet non magna.
Text Warning - Etiam porta sem malesuada magna mollis euismod.
Text Danger - Donec ullamcorper nulla non metus auctor fringilla.
**Widget Edit Panel widget**

The Widget Edit Panel appears on the main page of the Widget Editor in Service Portal Configuration. You can use this base system widget as-is in your or clone it to suit your own business needs.

Use the Widget Edit Panel to view widgets that have recently been updated, create a widget, or view an existing widget.

![Widget Editor](image)

**Service Portal service status widgets**

Use the service status widgets to display current, planned, and historical outages for business services to your end users.

The service catalog widgets are part of the Service Portal Service Status [com.glide.service-portal.service-status] plugin, which is activated automatically with the Service Portal for Enterprise Service Management [com.glide.service-portal.esm] plugin.
**Business Service Status widget**

View how services are running on your system. You can use this base system widget as-is in your or clone it to suit your own business needs.

The Business Service Status widget pulls information from the cmdb_ci_service table. You can change where the data comes from in a cloned version of the widget by adjusting the settings in the widget server script.

<table>
<thead>
<tr>
<th>Status History</th>
<th>Jun 12</th>
<th>Jun 13</th>
<th>Jun 14</th>
<th>Jun 15</th>
<th>Jun 16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bond Trading</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Bond Trading - DR</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Client Services</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>E-Commerce</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Electronic Messaging</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Email</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>IT Services</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Outlook Web Access (OWA)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>PeopleSoft Asset Lifecycle Mgmt</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>PeopleSoft CRM</td>
<td>✔</td>
<td>✔</td>
<td>✔️</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>PeopleSoft Enterprise Services</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>PeopleSoft Financials</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>
Instance options

Business Service Status widget instance options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the widget. This only appears in the header for the widget instance options, it is not user-facing. To change the title for the list of services, clone and edit the widget HTML.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon for the widget. This is not user-facing.</td>
</tr>
<tr>
<td>Number of Services</td>
<td>The number of services displayed in the widget. The default number is 250.</td>
</tr>
</tbody>
</table>

Current Status widget
The Current Status widget displays any issues reported in the system. You can use this base system widget as-is in your or clone it to suit your own business needs.

The Current Status widget checks the Outages [cmdb_ci_outage] table to see if the system is experiencing any outages.

Service owners and service desk managers report planned or unplanned outages by creating outage records. Each outage record includes Begin and End fields to indicate the duration of the outage. If the End time is later or empty, then the outage is still ongoing. The Current Status widget displays all ongoing outages.
Current Status widget

The Current Status displays outages only for services, which are tracked in the Services [cmdb_ci_service] table.

Instance options

Use the instance options to configure the Current Status widget for a portal page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show outage details</td>
<td>Option to display details from the Outage [cmdb_ci_outage] record.</td>
</tr>
<tr>
<td>Standalone</td>
<td>Option to remove explanatory information. This option also adds a link to more information.</td>
</tr>
</tbody>
</table>

Planned Maintenance widget

Describes any planned system maintenance. You can use this base system widget as-is in your or clone it to suit your own business needs.

The widget gathers information from the cmdb_ci_outage table. Any planned maintenance within the following five days appears in the Planned Maintenance widget.
**Planned Maintenance widget**

**Instance options**

The Planned Maintenance widget does not have any included instance options.

*Service History widget*

Displays the history of specific service's status. For example, if the Bond Trading widget has a history of planned outages or degradations, the widget displays those with a varied color scheme to differentiate the outage type. You can use this base system widget as-is in your or clone it to suit your own business needs.
Service History widget

Instance options

The Service History widget does not include any instance options.

Service Status widget

The Service Status widget provides a visual representation of service availability over the past three months. You can use this base system widget as-is in your or clone it to suit your own business needs.

The Service Status widget displays the history of service availability for one service from the Services [cmdb_ci_service] table. The widget uses the page URL to determine which service to represent.
### Service Status widget

Each pill represents one day. Each color correlates with a type of service availability.

<table>
<thead>
<tr>
<th>Color</th>
<th>Service availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>No issues</td>
</tr>
<tr>
<td>Blue</td>
<td>Planned maintenance</td>
</tr>
<tr>
<td>Yellow</td>
<td>Service degradation</td>
</tr>
<tr>
<td>Red</td>
<td>Outage</td>
</tr>
</tbody>
</table>

### Instance options

The Service Status widget does not have any included instance options.

*Service Status Legend widget*

Use concurrently with the Status History widget to show what the icons in the Status History widget mean. You can use this base system widget as-is in your or clone it to suit your own business needs.
Service Status Legend widget

Instance options

The Service Status Legend widget does not have any included instance options.

Service Status Subscription widget

Used in conjunction with the service status widget. Users subscribe to receive updates about the service status. You can use this base system widget as-is in your or clone it to suit your own business needs.

Service Status Subscription widget

Instance options

The Service Status Subscription widget does not have any included instance options.

Widget instances

When you add a widget to a page using the Service Portal Designer, it creates a widget instance. A widget instance is a reference to a widget that contains a location, properties, and CSS specific to that instance. Adding the same widget multiple times to the same page creates multiple instances.

For example, the Icon Link widget displays as many different versions of itself as you add to a page.
Icon link widgets

All widget instances point to a widget. If you make changes in that specific widget, all of the widget instances receive that change as well. You can also make changes specifically to a widget instance and only the widget instance will be affected.

Configure widget instance options

Each instance of the widget you configure remains unique, so you can have several instances of the same widgets on a page. For example, each instance of the cool clock widget on a page shows a different time zone. Configure a widget on a page by adjusting the instance options.

Role required: admin or sp_admin

Each time you add a widget to a page it creates a record on the sp_instance table with the following information:

• Reference to the column where the widget is located
• Reference to a widget
• Configuration for a widget in the form of pre-defined form fields and an Additional Options field in JSON format

1. On a page in the Service Portal Designer, point to the Edit icon (edit) in a widget to open the widget instance options. You can also access widget instance options using the control + right-click menu.

2. From the Instance Options window, make the selections you want to configure your widget.

Instance options vary depending on which widget you select.
Advanced users can configure the available options for a widget. For more information, see Widget option schema.

**Widget context menu**

From any rendered Service Portal page you can CTRL+right-click a widget to see more configuration options in a context menu.

For example, navigate to **Service Portal > Service Portal Home** to open a sample portal page. CTRL +right-click Knowledge Base on that page.
Note: You must have the admin or sp_admin role to see the widget context menu. When you impersonate a user without one of those roles, you can still see the menu. However, a regular user signed in without those roles cannot see the menu.

### Widget context menu options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widget performance</td>
<td>How long it takes for a widget to load</td>
</tr>
<tr>
<td>Instance options</td>
<td>Specify an instance of a widget. Widgets instance options vary depending on the widget you select. For example, the instance options for the cool clock widget include different time zones for each instance, so you can have the same clock four times on a page, but with all different time zones.</td>
</tr>
<tr>
<td>Instance in Page Editor</td>
<td>Opens that instance of the widget in the Page Editor</td>
</tr>
<tr>
<td>Page Designer</td>
<td>Opens the widget in the Service Portal Designer, which lets you add containers, columns, and widgets. You can add styling from the Service Portal Designer to your specific widget or to the page the widget lives on.</td>
</tr>
<tr>
<td>Edit Container Background</td>
<td>Make changes to the layout in which the widget is located.</td>
</tr>
<tr>
<td>Widget Options Schema</td>
<td>Define the actual options you can select for an instance of a widget. For more information on configuring your own instance options, see Widget option schema.</td>
</tr>
<tr>
<td>Widget in Form Modal</td>
<td>Opens the widget form in a pop up window so you can make quick changes to the widget.</td>
</tr>
<tr>
<td>Widget in Editor</td>
<td>Opens the widget in the Widget Editor. You can use the Widget Editor to configure HTML templates, CSS, client scripts, service scripts, and demo data for the widget.</td>
</tr>
<tr>
<td>Log to console: $scope.data</td>
<td>The $scope.data object passes data from the server to the client side controller. Instead of adding console.log messages or alerts into the controller code, you can just log the $scope.data object to the browser console and view the data there.</td>
</tr>
<tr>
<td>Log to console: $scope</td>
<td>Similar to the $scope.data object, except it logs everything in $scope to the console.</td>
</tr>
</tbody>
</table>

### Widget developer guide

Develop custom widgets in the Service Portal using AngularJS, Bootstrap, and the ServiceNow API.

### What to know before you begin

To develop widgets, you need ServiceNow API experience to:

- Run record queries on the server.
- Create and update records.

You need AngularJS experience to:

- Bind variables to client controllers.
- Access server objects in a widget.
- Gather user input.
Optionally, you can build on the Bootstrap template by accessing Bootstrap components. Service Portal uses Bootstrap version 3.3.6.

**Parts of a widget**

Like Angular directives, widgets execute a specified behavior within a Service Portal page. A widget includes mandatory and optional scripting components.

**HTML template**

A mandatory widget component.

The HTML template requires knowledge of AngularJS to display and gather data. Use the HTML template to:

- Render the dynamic view that a user sees in the browser using information from the model and controller.
- Bind client script variables to your markup.
- Gather data from the end user.

**Client script**

A mandatory widget component.

A client script requires knowledge of both the ServiceNow API and AngularJS to create a client controller. Use the client script to:

- Map server data from JavaScript and JSON objects to client objects.
- Process data before rendering it.
- Pass data to the HTML template.
- Pass user input and data back to the server for processing.

**Server script**

A mandatory widget component.

A server script requires knowledge of the ServiceNow API to work with record data. Use the server script to:

- Set the initial state of the widget.
- Send record data to the widget client script using the `data` variable.
- Run server-side queries.

**Link function**

An optional widget component.

The link function requires knowledge of AngularJS. Use a link function to directly manipulate the DOM.

**Option schema**

An optional widget component.

Allows a Service Portal admin to configure a widget. Use the option schema to:

- Specify the parameters for a widget.
- Allow admin users to define instance options for a widget instance.
- Develop flexible, reusable widgets.
Angular Providers

An optional widget component.

Angular Providers require knowledge of AngularJS. Use Angular Providers to:

• Keep widgets in sync when changing records or filters.
• Share context between widgets.
• Maintain and persist state.
• Create reusable behaviors and UI components and inject them into multiple widgets.

Dependencies

An optional widget component.

A widget dependency is an external resource used by your widget such as JavaScript or CSS files.

Global objects in widgets

When a widget begins to render for the first time on a page, the server script executes first and accesses three global objects: input, options, and data. Because the input variable is a data object sent from the client script, this variable is undefined when first initialized.

When a widget is first instantiated, the server script:

1. Initializes an empty data object.
2. Initializes the **input** object with any data sent from the client controller, or the **options** object with any data used to initialize the widget.

3. Sends the **data** object to the client controller as JSON.

The client script:

1. Accesses the server **data** object using `c.data`.

   **Note:** By default, widgets use the `c` variable to represent the controller instance using `controller as` syntax. You can change this variable when creating or cloning widgets.

2. Uses `server.update()` to post changes to the data model. This method updates the server script using the **input** object.

   **Note:** After calling `server.update()`, the client script **data** object is automatically overwritten by the server script **data** object.

3. Uses `c.options` to access the values used to invoke the widget on the server. This object is read-only.

### Using the Widget Editor

When you create a widget, a record is created in the `sp_widget` table. However, you can use the Widget Editor in Service Portal Configuration as your scripting environment. The Widget Editor is a full page application similar to an IDE. You can show the parts of the widget you want to edit and hide the rest, while previewing your changes in real time.
Recommendations for developing widgets

When developing custom widgets, keep these recommendations in mind for optimal performance, scalable development, and a good user experience.

Create a default state that provides an example to the end user
A widget does not have instance options defined when initially added to a page. A widget in this empty state can appear blank and cause confusion. In situations where a widget requires some initial configuration, ensure that your widget has a default state that communicates to the admin what configuration is necessary.

Widgets can also be created with demo data. Demo data can also be used to:

- Clearly demonstrate the widget functionality to the user.
- Provide data when previewing the widget in the widget editor. (Demo data is not visible in the designer).

Learn more: Tutorial: Build a custom widget.

Embed a widget rather than clone when possible

Embedding an existing widget into your custom widget takes advantage of pre-existing functionality without cloning or duplicating code. You can still pass parameters into the embedded widget to control its behavior.

Learn more: Embed an existing widget

Add limits to GlideRecord queries to improve performance

If your server-side script uses GlideRecord queries, the `setLimit` function can restrict the number of records returned, and improve response time on queries. For added flexibility, you can tie this limit to an instance option rather than assigning a hard-coded value (for example: `now_GR.setLimit(options.limit || 100)`).

Learn more: GlideRecord setLimit Function

Create a directive instead of embedding a complex widget

When an embedded widget is called from the server, all the scripts associated with that widget are returned. If you only need a subsection of a widget, embedding the entire widget creates unnecessary overhead. Instead, use directives to share lightweight code between widgets. Directives are useful, for example, when building UI components. Complex components with server-side and client-side functionality are best left as widgets. Use a directive instead of an embedded widget to:

- Share scope or custom scope behavior with multiple widgets.
- Share a reusable, lightweight subsection of a widget.
- Share a common UI feature, such as a list or an avatar.
- Augment widget behavior.

Learn more: Reuse components with Angular Providers.

Use a service or factory to share data and persist state

Data services and factories maintain and persist state in a widget without requiring multiple calls to the server, enabling you to:

- Keep widgets synchronized when changing records or filters.
- Share data between widgets.
- Develop more performant widgets.

Learn more: Reuse components with Angular Providers.

Handle events with a publish/subscribe service
Avoid using `$broadcast` in the DOM. `$broadcast` dispatches the event name to all child scopes notifying registered listeners, which can be an expensive call that requires the use of the `$rootScope` global object.

Instead, use a publish/subscribe service to handle events. When using a publish/subscribe service, a clear relationship forms between your widgets through callback handlers. In this model, you can better control the state of your events.

**Use REST calls or `server.get` to fetch data from the server**

When you call `server.update()`, the entire widget is returned from the server. If your widget includes divergent code paths, multiple calls to update the server can affect performance. As a rule, use your server script to set up the initial state of your widget. For subsequent updates, use scripted REST APIs that call script includes on your instance. This practice:

- Separates business logic from UI elements.
- Centralizes your code, allowing changes to be made in one place.

You can also use `server.get` to pass information to the server. Use this function along with `input.action` to execute specific parts of the server script.

**Develop with localization, accessibility, and UI in mind**

To create the best experience for your users, follow these guidelines:

- Consider the impact of your widget in a mobile environment. For example, avoid using mouse-over and other events that do not translate to a mobile device.
- Use SCSS variables to reuse items. See SCSS variables.
- Use variable names when using colors.
- Wrap strings for translation in localization APIs. See Internationalize a widget.

**Remove unused Angular Providers from client script**

For easier maintenance, remove any unused Angular Providers that were injected into the client script function statement.

**Avoid using `<script>` tags in HTML templates**

To lessen the likelihood of production issues in Service Portal, avoid using inline templates using `<script>` tags in a widget's HTML template. Instead, create a related Angular `ng-template` record for the widget.

**Clone a widget**

Take advantage of existing code by cloning and editing an existing widget.

Role required: admin or `sp_admin`

*Note:* Base system widgets are read-only so you can benefit from future updates. To make changes, you can clone base system widgets. However, cloned widgets are considered custom and don't benefit from future updates to the widgets they were cloned from.

1. Open the Widget Editor in the Service Portal Configuration page, then select an existing widget from the Select a widget list. For example, select **Hello World 2**.
2. From the list menu in the widget header, click **Clone "Hello World 2"**.

3. Enter a name for the cloned widget. The widget ID is created automatically based on the widget name.

4. Optional: Select **Create test page** to automatically create a page containing the widget.
5. Use the check boxes to show or hide the different components of the widget editor as needed. Make changes to the HTML Template, CSS, client script, server script, or the link function.
¡Hola, mundo!
6. In order to enable a preview of your widget, use **Enable Preview** from the menu. Use the eye icon that appears to show or hide a preview of your widget.

If you clone a widget that uses the Angular ng-template, you must manually clone the template and change the name of the template reference in the widget.

For example, the header menu widget uses the Angular ng-template `menuTemplate`. If you clone the header menu widget, you must also clone the `menuTemplate` and give the clone a unique name. When you open the clone of the header menu widget, you can see a reference to the `menuTemplate` in the HTML.

```
<html>
  <ul class="nav navbar-nav">
    <div class="header-loader" ng-show="loadingIndicator">
      <div class="hidden-xs sp-loading-indicator la-sm">
        <div></div>
        <div></div>
      </div>
    </div>
    <li ng-repeat="item in data.menu.items" ng-class="{dropdown: item.items.length > 0}" ng-include="'MenuTemplateCopy'"></li>
  </ul>
</html>
```

**menuTemplate in header widget HTML**

### Create a new widget

Create a new widget to build a custom widget from scratch.

**Role required:** admin or sp_admin

1. **Navigate to** Service Portal > Service Portal Configuration > Widget Editor.
2. **Click** Create a new widget.
3. Enter a name for the new widget. The widget ID is created automatically based on the widget name. Optionally select **Create test page** to automatically create a page containing the widget.

**Note:** After completing development of a widget with a test page, delete the test page. Maintaining test pages can create clutter when managing pages.
4. Click **Submit**.

The widget HTML template, client script, and server script display in the widget editor. Basic script templates are included as a guide.

---

**Widget option schema**

Widget instances allow users to uniquely configure each widget they add to a page. Use the option schema to define the parameters for your widget.

**Storing instance options**

When developing a widget, you can edit the option schema to create parameters for your widget, or you can create a table to store instance options. If you edit the existing option schema, any instance options defined are stored in JSON format in the **Additional options, JSON format** field in the sp_instance table. The following field types are available:

- String
- Boolean
- Integer
- Reference
- Choice
• Field_list (depends on table)
• Field_name (depends on table)
• Glide_list

To use other field types not supported in the option schema, create an extension table to store your custom widget option schema. Using a table enables you to:

• Add any ServiceNow field type, including fields with advanced customization, to the option schema.
• Define a complex option schema.
• Search and filter instance options.

**Note:** While storing options in a table enables you to define more complex options, this method is more difficult to maintain than editing the option schema. To avoid creating unnecessary tables and adding additional server calls to your widget, edit the existing option schema when possible. Store options in a table only when complex or searchable options are required.

Using options in a widget

Access options in the widget from both the client script and the server script using the `options` global variable. You can access to any option value in your widget client script or server script using `options.optionName`.

**Client script**

```javascript
function() {
  /* widget controller */
  var c = this;
  console.log(c.options.text_color) //Outputs the text_color option for this instance
}
```

**Server script**

```javascript
(function() {
  $sp.log(options.text_color) //Logs the value of the text_color option to the browser console.
})();
```

Defining default options

Before an option value is set on an instance, it appears as an undefined value when you access that option variable. Use the widget server script to specify default values for your options.

```javascript
(function() {
  options.text_color=options.text_color||"blue";
  options.maximum_entry_count=options.maximum_entry_count||5;
})
```

**Edit the widget option schema**

Widget instances allow users to uniquely configure each widget they add to a page. Edit the option schema to define basic parameters for your widget.

**Role required:** admin or sp_admin

1. Navigate to Service Portal > Service Portal Configuration > Widget Editor.
2. Select the widget you want to configure the option schema for.

3. Click the menu icon (≡) and select **Edit option schema**.
   This option only appears for users that have the right to edit the widget.

4. Click + to add a widget option.
5. Define a label, name, type, hint and form section. More fields appear depending on the type you select.

Adding flexible widget options allows you to create more reusable widgets. You can add default values to help users understand each widget option. If you do not select a form section, the default is set to Other options.
6. Click **Save**.

The option schema you defined is stored in JSON format in the **Option schema** field in the `sp_widget` table. Based on this option schema, each instance of the widget can use individually defined instance options.
7. Test the option schema by adding the widget to a page in the Service Portal Designer.
   a) Navigate to Service Portal > Service Portal Configuration > Service Portal Designer.
   b) Add the widget to a page and click the edit icon on the widget instance to view the instance options.
   c) Configure the widget instance options.
   d) View the configuration by navigating to the instance record in the sp_instance table. The instance options are stored in JSON format in the Additional options, JSON format field.

Store instance options in a table
Create a table to store widget instance options instead of editing the existing option schema. When using a table as your widget option schema, you can define custom fields using any ServiceNow field type, add filters to fields, and search or query instance options.

Role required: admin or sp_admin
To define a custom option schema, add fields to an sp_instance extension table, then set your widget to use the extension table as a data source. Using an extension table enables you to:

- Add any ServiceNow field type, including fields with advanced customization, to the option schema.
- Define complex widget options.
- Search and filter instance options.

Note: While storing options in a table enables you to define more complex options, this method is more difficult to maintain than editing the option schema. To avoid creating unnecessary tables and adding additional server calls to your widget, edit the existing option schema when possible. Store options in a table only when complex or searchable options are required.

1. Create a table that extends an sp_instance table to store your custom option schema.
   a) Navigate to System Definition > Tables.
   b) Click New.
   c) Define a label and name.
   d) In the Extends table field, select an sp_instance table that provides the necessary fields.

<table>
<thead>
<tr>
<th>Instance table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance [sp_instance]</td>
<td>Includes base instance fields.</td>
</tr>
<tr>
<td>Instance with Table [sp_instance_table]</td>
<td>Includes sp_instance fields and fields to display table data such as Table and Filter.</td>
</tr>
</tbody>
</table>

   e) Save the form.

2. Define custom fields in the extension table.
You can define any field type to use in your option schema by adding new columns in the Columns list.
3. Update your widget to use the extension table as a data source.
   a) Navigate to **Service Portal > Widgets**.
   b) Open the widget you would like to create custom options for.
   c) In the **Data table** field, select your `sp_instance` extension table.

4. Configure the extension table form to display the desired fields. Fields configured on the form are available as instance options.
   a) Navigate to the extension table form: `<yourInstance>/your_extension_table>.do`.
   b) Right-click the header menu and select **Configure > Form Layout**.
   c) Add the fields to the form.
   d) Click **Save**.
5. Configure the widget to display the desired fields as instance options.
   a) Navigate to Service Portal > Widgets.
   b) Open the widget that has the extension table set as the data source.
   c) Use the Fields slushbucket to select fields to display as instance options.
   d) Save the form.

Test the option schema by adding the widget to a page in the Service Portal Designer. Click the edit icon on the widget instance to view the instance options. After configuring the widget instance options, view the configuration by navigating to the instance record in the sp_instance extension table.

Reuse components with Angular Providers

Angular Providers are reusable components that can be injected into multiple widgets. To ensure quick loading widgets and a high performing portal, create Angular Providers instead of overloading your client controllers with persistent data and additional logic. With Angular Providers, you can maintain data for the lifetime of your Service Portal and reuse components and data objects across multiple widgets.

Role required: admin or sp_admin

By creating an Angular Provider, you can:

• Keep widgets in sync when changing records or filters.
• Share context between widgets.
• Maintain and persist state.
• Create behaviors and inject them into multiple widgets.

To learn more, visit Angular Providers.

Tip: For easier maintenance and troubleshooting, remove any unused providers from the Angular Providers related list in the Widget [sp_widget] table.

   The Widget Angular Providers table opens.
2. Click **New** to create a new record.

3. Select the type of Angular Provider.
   - Directive
   - Factory
   - Service

To facilitate migration to ECMAScript 6 in the future, consider using services over factories.

4. Define a name.
   You will use the name to associate the Provider with your widget.

5. Add a script in the **Client Script** field.
   A basic factory that formats a number in US currency.

   ```javascript
   function formatterFactory()
   {
     var myVal = Number;
     return {
   ```
6. Associate the Angular Provider with a widget.
   a) Navigate to `<yourInstanceURL>/sp_config?id=widget_edit`.
   b) Open the widget you would like to associate with the Angular Provider.
   c) Under Related Lists, select Angular Providers.
   d) In the Angular Providers list, click New.
   e) In the Angular Provider field, select the appropriate Provider. Check the Widget field to ensure that you are associating the Angular Provider with the correct widget.

f) Click Save.
7. Update the appropriate scripts in your widget to inject the Angular Provider into the widget.

Inject the factory into your widget client script by passing the name of the factory as an argument in your client controller function. You can then access the object defined in the factory function in your widget client script.

```javascript
function(formatterFactory) {
  /* widget controller */
  var c = this;
  console.log(formatterFactory.format(300));
}
```

If defining a directive, use the directive in the widget HTML template.

8. To edit the Angular Provider after it is registered with your widget, open the Angular Provider client script in the widget editor.

   a) Navigate to Service Portal Configuration > Widget Editor.
   b) Under Edit an existing widget, select the widget associated with your Angular Provider.
   c) In the Show menu, open the Dependencies list and select the Angular Provider.

![Dependencies list](image)

**Note:** Only Angular Providers associated with the widget are displayed in the Dependencies list. This list includes any external resources your widget depends on.

The Angular Provider client script displays in the widget editor. In the widget editor interface, you can edit and save your widget and Provider scripts at the same time.

To use an Angular Provider with multiple widgets, register your Provider with each widget and update the appropriate scripts.

**Embedded widgets**

Embed a widget in the HTML template, server script, or client script.

**Embed a widget in an HTML template**

Use the `<widget>` element to embed a widget in an HTML template. Pass in the ID of the widget you are trying to embed as a parameter.

```html
<div>
  <widget id="widget-cool-clock"></widget>
</div>
```

If a widget has an option schema, you can define instance options in JSON format.

```html
<widget id="widget-cool-clock" options='{"zone": "America/Los_Angeles","title": "San Diego, CA"}'></widget>
```
Alternatively, you can define options in the widget server script.

**HTML template**

```
<widget id="widget-cool-clock" options='data.clockOptions'></widget>
```

**Server script**

```
(function() {
  data.clockOptions = {
    "zone": "America/Los_Angeles","title": "San Diego, CA"};
})();
```

**Embed a widget in a client script**

Use `spUtil.get()` to get a widget model in the client script.

```
spUtil.get("widget-sc-cat-item", {sys_id: "your_catalog_item_sys_id"}).then(function(response) {
  c.catalogItemWidget = response;
});
```

When using the `spUtil` class in a widget client script, you must inject the class into the client script function. The following example embeds the Cool Clock widget:

**Client script**

```
function(spUtil) {
  var c = this;
  spUtil.get("widget-cool-clock").then(function(response) {
    c.myClockWidget = response;
  });
}
```

**HTML template**

```
<sp-widget widget="c.myClockWidget"></sp-widget>
```

**Embed a widget in a server script**

Use `$sp.getWidget()` to get a widget model in the server script.

```
data.catalogItemWidget = $sp.getWidget("widget-sc-cat-item");
```

The following example embeds the Cool Clock widget:

**Server script**

```
(function() {
  var coolClockOptions = {
    "zone": "America/Los_Angeles","title": "San Diego, CA"}
  data.coolClockWidget = $sp.getWidget('widget-cool-clock', coolClockOptions);
```
HTML template

<sp-widget widget="data.coolClockWidget"></sp-widget>

Widget model properties

When a widget model is called from within another widget, the HTML template, client script, and link function are loaded just as they are in the sp_widget record. The data property is the result of the widget server script execution. Anything that you put on the data object on the server is available in the data object on the client.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>client_script</td>
<td>string</td>
<td>Widget client script field.</td>
</tr>
<tr>
<td>css</td>
<td>string</td>
<td>Compiled CSS output from the SASS field for the widget.</td>
</tr>
<tr>
<td>data</td>
<td>object</td>
<td>Data object containing keys and values from the widget server script.</td>
</tr>
<tr>
<td>dependencies</td>
<td>array</td>
<td>Any third-party libraries to load before the widget executes.</td>
</tr>
<tr>
<td>options</td>
<td>object</td>
<td>Options used to initialize the widget.</td>
</tr>
<tr>
<td>template</td>
<td>string</td>
<td>HTML template field for the widget.</td>
</tr>
</tbody>
</table>

*Embed a widget multiple times with custom options*

Embed the cool clock widget multiple times using custom options.

**Role required: admin or sp_admin**

Create a widget that embeds multiple instances of the cool clock widget, each with a different time zone and title. Open the cool clock widget in the Widget Editor to see widget options referenced in the HTML template and the Client Script.
Cool Clock widget with Options highlighted

1. Clone the Cool Clock widget with the name **Embedded clock.**
2. Replace the code blocks with the following:

**HTML Template**

```html
<div class="panel panel-default">
  <div class="panel-heading">Time across the US</div>
  <div class="panel-body">
    <div class="row">
      <div class="col-sm-3" ng-repeat="myClock in c.data.clocks">
        <sp-widget widget="myClock"></sp-widget>
      </div>
    </div>
  </div>
</div>
```

**CSS**

```css
.panel {
  margin-top: 10px;
}
```

**Client Script**

```javascript
function() {
  // nothing to do here...
}
```

**Server Script**

```javascript
(function() {
  var options = [
    {zone: "America/Los_Angeles", title: "San Diego"},
    {zone: "America/Denver", title: "Denver"},
    {zone: "America/Chicago", title: "Chicago"},
    {zone: "America/New_York", title: "New York"}
  ];

  data.clocks = [];
  for (var i in options) {
    data.clocks.push($sp.getWidget("widget-cool-clock", options[i]));
  }
})();
```

Each instance of the clock in the embedded clock widget appears with a different time zone.
Sample clock options

Create a widget dependency

In Service Portal, you can link JavaScript and CSS files to widgets to create dependencies between widgets and third-party libraries, external style sheets, and angular modules.

Role required: admin or sp_admin

Dependencies are loaded asynchronously from the server when needed.

Widgets can have as many or as few dependencies as needed. However, the more you add, the more content a widget must download to render on the page. Keep dependencies as small as possible for more efficient load times.

1. Create a dependency package.

A dependency package is a collection of JavaScript and CSS files that can be then connected to a widget.

a) Navigate to Service Portal > Dependencies.

b) In the dependency record, define the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your dependency. (Useful for selecting a dependency from a dropdown list.)</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for the dependency record.</td>
</tr>
<tr>
<td>Include on page load</td>
<td>Select if you want your dependency to be loaded onto the page on the initial page load of Service Portal, or leave unchecked to load the dependency only when the linked widget is loaded onto a page.</td>
</tr>
</tbody>
</table>
### Field

**Angular module name**  
Optional. Define the value if the linked JavaScript is an Angular module. Provide the name of the Angular module being loaded, so that it can be injected into the Service Portal Angular application.

#### 2. Add files to the dependency package.

After you save the information for your dependency package, use the related lists to add JS and CSS Include files. For each related list, include the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the script include.</td>
</tr>
</tbody>
</table>
| Source      | Depending on whether you add a JS Include or a CSS Include, select one of these options from the list:  
|             | • URL  
|             | • UI script (for a JS Include) or Style Sheet (for a CSS Include)          |
|             | For a JS Include, use the UI Script field to reference a UI Script found in [System UI > UI Scripts](#).  
|             | For the CSS Include, use the Style Sheet field to reference a record in the sp_css table. |

#### 3. Add a dependency package to a widget.

After you have created a dependency package and added files, create a relationship between the dependency and a widget.

a) Navigate to Service Portal > Widgets and find the widget record you want to add the dependency to.

b) From the Dependencies related list, click **Edit**.

c) In the slushbucket, find the dependency you created and double-click to add it to the selected items column on the right.

d) Save the page to return to the widget record.

---

### Include a font icon in a single widget

If you only want one widget to have access to a font icon, include the font icon in a single widget.

**Role required:** admin or sp_admin

Adding an icon to a specific widget keeps the icon scoped and prevents it from interfering with other CSS on the page.

1. In the platform UI, navigate to Service Portal > Widgets, then click the widget you want to add an icon to.

2. Attach the individual icon file to the widget record.

3. In the HTML template, include something like the following:

```html
<div>
  <i class='font-family'>icon_name</i> you did it!
</div>
```
Make sure the class is exactly the same as the font family called out in the CSS. For example `<i class='material-icons'> should be the same as the .material-icons included in the CSS. The icon_name should match the name of the file you attached.
4. In the CSS field for the widget, add the CSS for the font-icon definition. Most font-icon sets include a CSS file similar to the material icons one used below. Use the sys_id of the attachment as the `src` in the CSS.

```css
@font-face {
  font-family: 'Material Icons';
  font-style: normal;
  font-weight: 400;
  src: url('https://www.gstatic.com/c classic_materialicons/16px/v4/Classic_Material_Icons.ttf') format('truetype');
}

.material-icons {
  font-family: 'Material Icons';
  font-style: normal;
  font-weight: normal;
  font-size: 24px; /* Preferred icon size */
  display: inline-block;
  line-height: 1;
  text-transform: none;
  letter-spacing: normal;
  word-wrap: normal;
  white-space: nowrap;
  direction: ltr;
  -webkit-font-smoothing: antialiased;
  font-feature-settings: 'liga';
}
```

An icon that you can select in the widget or widget instance.
To use custom font-icons across widgets, add the icon to a page or make it a widget dependency.

*Include font icons as a widget dependency*
You can include font icons wherever a widget is loaded by including them as a widget dependency.

Role required: admin or sp_admin

**Note:** CSS included as a widget dependency is not scoped and can disrupt other CSS on a page.

1. In the platform UI, navigate to **Service Portal > CSS** and create a new style sheet.
2. Attach the font-icon set to the sp_css record you created, and use the sys_id of the attachment as the src for the font icon.

3. Navigate to **Service Portal > Dependencies** and create a new dependency.
4. Attach the CSS record you created to the new dependency using the CSS Includes related list.

Internationalize a widget

Use the $() or gs.getMessage() syntax in widgets to tag strings for translation so you can localize your Service Portal content.

The $() or gs.getMessage() searches in the messages table [sys_ui_message] in the platform to see what the translation would be.
Use the HTML template to internationalize strings in a widget. Type the following in an HTML template.

```html
<div>
  <p>${This message will be internationalized.}</p>
  <p>However, this will NOT be.</p>
</div>
```

Writing text as `$(message)` is the equivalent of writing `$gs.getMessage("message")` in other parts of the system, but written as a more legible shorthand.

**Note:** In some cases, the translation might have quotes or double quotes on it. That could lead to JavaScript errors if you are using the `$()` syntax in the client script. The safest way to fetch a translated message is to do it in the server script. Then, assign the value to a client-side Angular binding.

Translating strings in the client script

```javascript
function() {
  var c =this;
  c.message="${This message will be internationalized}";
}
```

HTML template:

```html
<div>
  <!-- The output of this text will be internationalized. -->
  <p>{{c.message}}</p>
</div>
```

Translating strings in the server script

Use the server script to translate schema options and other values during server-side runtime.

Server script

```javascript
function() {
  data.message=gs.getMessage("this message contains 'quotes'");
  //You can also translate schema options using the server script
  //For example, data.message=gs.getMessage(options.title);
}
```

HTML template

```html
<div>
  <p>{{c.data.message}}</p>
</div>
```

**Tutorial: Build a custom widget**

Follow this tutorial to build a custom widget that displays Service Catalog items. Use this tutorial as a model to help you understand the advanced scripting power of the Service Portal.

In this tutorial, you will create the Quick Order widget. This widget:

- Displays popular items to the user prior to any search.
- Queries the Service Catalog and displays available options to the user.
• Includes an embedded SC Catalog Item widget, allowing the user to view and order items within the Quick Order widget.
• Uses an Angular Provider to display a category icon beside each queried item.

*Create a widget and set up a template*
Create the Quick Order widget to query items in the Service Catalog.

Role required: admin or sp_admin

1. Navigate to **Service Portal > Service Portal Configuration** and click **Widget Editor**.
2. Click **Create a new widget**.
3. Define the following values.
   - **Widget Name**: Quick Order
   - **Widget ID**: quick_order
   - **Create a test page**: Active
   - **Page ID**: quick_order

Adding a widget to a test page creates a record in each of the following tables:
   - sp_page
   - sp_container
   - sp_row
   - sp_column
   - sp_instance
   - sp_widget

**Note:** You can use the Page Editor in Service Portal Configuration to view the hierarchy of elements on your test page.

4. Click **Submit**.
5. From the **Widget Editor**, open the Quick Order widget.
6. Add the following simple template to the HTML field.

```html
<div class="panel panel-primary">
  <div class="panel-heading">Request an item from the catalog</div>
  <div class="panel-body">
    My catalog results
  </div>
</div>
```

7. Click **Save**.
8. Preview your test page in a new tab using the following URL: `<yourInstanceUrl>/sp?id=quick_order`.

Your widget template displays on the test page.

Add a server script to query an instance table
After adding your widget and creating a basic template, you can define more advanced scripts that enable the user to query data from an instance table. Using client and server scripts, you can pass the data model between the client and server by querying data from the database, displaying it to the user, and sending any updates back to the server.

Role required: admin or sp_admin

1. From the **Widget Editor**, open the Quick Order widget.
2. Select **Server Script** to open the server script field.
3. Replace the default server script with the following custom script.

```javascript
(function() {
  if (input.keywords != null && input.keywords != '')
    data.items = getCatalogItems(input.keywords);

  function getCatalogItems(keywords) {
    var sc = new GlideRecord('sc_cat_item');
    sc.addActiveQuery();
    sc.addQuery('123TEXTQUERY321', keywords);
    sc.addQuery('sys_class_name', 'NOT IN',
                'sc_cat_item_wizard,sc_cat_item_content');
    sc.addQuery('sc_catalogs', 'e0d08b13c3330100c8b837659bba8fb4');
    sc.setLimit(100);
    sc.orderByDesc("ir_query_score");
    sc.query();
    var results = [];
    while (sc.next()) {
      if (!$sp.canReadRecord(sc))
        continue;

      var item = {};
      $sp.getRecordDisplayValues(item, sc, 'name,price,sys_id');
      item.category = sc.getValue('category');
      results.push(item);
    }
    return results;
  }
})();
```

This script performs a keyword search on the sc_cat_item table using the 123TEXTQUERY321 query method.

4. Replace the HTML template with the following script:

```html
<div class="panel panel-primary">
  <div class="panel-heading">Request an item from the catalog</div>
  <div class="panel-body">
    <input class="form-control" type="search" placeholder="Start typing here to search the list of catalog items" ng-model="c.data.keywords" ng-change="c.server.update()" ng-model-options="{debounce: 250}" />
    <ul class="list-group result-container">
    <ul>
```
This template adds a search field and displays the results of the query performed in the server script using the following Angular directives. To learn more about these directives, review the Angular API Reference.

### Angular directives used in the template

<table>
<thead>
<tr>
<th>Angular directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ng-model</td>
<td>Automatically reads and writes value changes to the model variable <code>c.data.keywords</code>.</td>
</tr>
<tr>
<td>ng-model-options</td>
<td>Configures ng-model behavior. In this template, ng-model updates the model after a user has stopped typing for 250 milliseconds.</td>
</tr>
<tr>
<td>ng-change</td>
<td>Executes <code>c.server.update()</code> after the model value changes. This function posts the data object to the server script. After the script is executed, the data object is automatically updated with the new values from the server generated data object.</td>
</tr>
<tr>
<td>ng-repeat</td>
<td>Creates a template from the parent element and child elements. For each item in <code>c.data.items</code>, an instance of the template is created and the expressions <code>{{item.name}}</code> and <code>{{item.price}}</code> are replaced with the values from each item.</td>
</tr>
</tbody>
</table>

5. Add the following script to the CSS - SCSS field:

```css
.result-container {
  margin-top: 10px;
}
```

6. Refresh your test page preview to view the changes.

As you type in the search box, matching catalog items appear. Try searching for `ipad`.

---

*Manage the empty state of a widget*

Display a list of popular items to the user before any search terms are entered.

Role required: admin or sp_admin
Because no search has been executed when the widget initializes, the server \texttt{input} variable is undefined. This empty state may cause confusion when a user first interacts with the widget. To solve this issue, give your widget something to display when the \texttt{input} variable is empty. This initial data can guide your users when initially interacting with your widget.

1. From the \textbf{Widget Editor}, open the Quick Order widget.
2. Replace the existing server script with the following script:

```javascript
(function() {
    if (input.keywords != null && input.keywords != '')
        data.items = getCatalogItems(input.keywords);
    else data.items = getPopularItems();

    function getCatalogItems(keywords) {
        var sc = new GlideRecord('sc_cat_item');
        sc.addActiveQuery();
        sc.addQuery('123TEXTQUERY321', keywords);
        sc.addQuery('sys_class_name', 'NOT IN',
                    'sc_cat_item_wizard,sc_cat_item_content');
        sc.addQuery('sc_catalogs', 'e0d08b13c3330100c8b837659bba8fb4');
        sc.setLimit(100);
        sc.orderByDesc("ir_query_score");
        sc.query();
        var results = [];
        while (sc.next()) {
            if (!$sp.canReadRecord(sc))
                continue;
            var item = {};
            $sp.getRecordDisplayValues(item, sc, 'name,price,sys_id');
            item.category = sc.getValue('category');
            results.push(item);
        }
        return results;
    }

    function getPopularItems() {
        var items = [];
        var count = new GlideAggregate('sc_req_item');
        count.addAggregate('COUNT','cat_item');
        count.groupBy('cat_item');
        count.addQuery('cat_item.sys_class_name', 'NOT IN',
                       'sc_cat_item_guide,sc_cat_item_wizard,sc_cat_item_content');
        count.addQuery('cat_item.sc_catalogs',
                       'e0d08b13c3330100c8b837659bba8fb4');
        count.orderByAggregate('COUNT', 'cat_item');
        count.query();
        while (count.next() && items.length < 9) {
            if (!$sp.canReadRecord("sc_cat_item",
                                   count.cat_item.sys_id.getDisplayValue()))
                continue; // user does not have permission to see this item
            var item = {};
            item.name = count.cat_item.name.getDisplayValue();
            item.category = count.cat_item.category.toString();
            item.price = count.cat_item.price.getDisplayValue();
            item.sys_id = count.cat_item.sys_id.getDisplayValue();
            items.push(item);
        }
        return items;
    }
});
```
This script introduces a new function `getPopularItems()` to query the database and return popular items when the `input` variable is empty.

3. Replace the HTML template with the following script:

```html
<div class="panel panel-primary">
  <div class="panel-heading">Request an item from the catalog</div>
  <div class="panel-body">
    <input class="form-control" type="search" placeholder="Start typing here to search the list of catalog items" ng-model="c.data.keywords" ng-change="c.server.update()" ng-model-options="{debounce: 250}" />
    <h5 ng-if="!c.data.keywords">Showing the most popular items</h5>
    <ul class="list-group result-container">
      <li class="list-group-item" ng-repeat="item in c.data.items">
        <a href="{{item.name}}"></a><span class="pull-right">{{item.price}}</span>
      </li>
    </ul>
  </div>
  <div class="panel-footer" ng-if="c.data.keywords">
    <ng-pluralize count="c.data.items.length" when="{'0': 'No items found for ',
      '1': 'One item matching ',
      'other': 'Found {} items matching '}">
      {{c.data.keywords}}
    </ng-pluralize>
  </div>
</div>
```

This script provides a template to display the popular items returned from the server script.

4. Refresh your test page preview to view the changes.

The widget displays popular items to the user prior to any search input.

---

**Embed an existing widget**

Enable the user to view and purchase Service Catalog items in the Quick Order widget by embedding the SC Catalog Item widget.

Role required: admin or sp_admin
Instead of duplicating code, you can embed widgets to leverage pre-existing functionality. The SC Catalog Item widget is a base system widget that enables the user to view and purchase Service Catalog items.

1. Inspect the SC Catalog Item widget.

   Before embedding the SC Catalog Item widget, inspect the widget to understand what data it needs access to. You may need to update your Quick Order widget client or server script to make sure that the correct data is passed to the embedded widget.

   a) Navigate to `<yourInstanceURL>/sp_config?id=widget_editor`

   b) Open the SC Catalog Item widget.

   c) Note that the widget ID is `widget-sc-cat-item`. You will use this ID to embed the widget model in the client script.

   d) Examine the server script.

       Notice that the `data` object includes a `sys_id` property populated by either the input or options objects. If neither input nor options include a `sys_id`, the `$sp.getParameter()` method retrieves the `sys_id` from the request query string.
To populate the input object, you can pass a catalog item sys_id from the Quick Order widget client script.

2. From the Widget Editor, open the Quick Order widget.
3. Replace the Quick Order widget client script with the following script.

```javascript
function($location, spUtil) {
    var c = this;
    c.select = function(item_id) {
        if (c.openItem == item_id) {
            c.openItem = null;
            return;
        }
        renderCatalogItemWidget(item_id);
    }
}
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
function renderCatalogItemWidget (item_id) {
    c.catalogItemWidget = null;
    spUtil.get("widget-sc-cat-item", {sys_id: item_id}).then(function(response){
        c.catalogItemWidget = response;
        c.openItem = item_id;
    });
}

This script uses spUtil.get() to retrieve the widget model by ID (widget-sc-cat-item) and define the {sys_id: item_id} object. This object posts to the server script as input.

4. Replace the HTML template with the following script:

```html
<div class="panel panel-primary">
    <div class="panel-heading">Request an item from the catalog</div>
    <div class="panel-body">
        <input class="form-control" type="search" placeholder="Start typing here to search the list of catalog items" ng-model="c.data.keywords" ng-change="c.server.update()" ng-model-options="{debounce: 250}" />
        <h5 ng-if="!c.data.keywords">Showing the most popular items</h5>
        <ul class="list-group result-container">
            <li class="list-group-item" ng-repeat="item in c.data.items">
                <a href ng-click="c.select(item.sys_id)">{{item.name}}</a><span class="pull-right">{{item.price}}</span>
                <div class="catalog-item" ng-if="item.sys_id == c.openItem">
                    <sp-widget ng-if="c.catalogItemWidget" widget="c.catalogItemWidget" />
                </div>
            </li>
        </ul>
    </div>
    <div class="panel-footer" ng-if="c.data.keywords">
        <ng-pluralize count="c.data.items.length"
            when="{'0': 'No items found for ',
                '1': 'One item matching ',
                'other': 'Found {} items matching '}">
            {{c.data.keywords}}
        </ng-pluralize>
    </div>
</div>
```

This template:
- Adds on-click behavior using the ng-click directive.
- Displays the embedded SC Catalog Item widget using the sp-widget directive.

5. Replace the CSS with the following script:

```css
.result-container {
    margin-top: 10px;
}
.catalog-item {
    background-color: #f5f5f5;
    padding: 10px;
    @include border-top-radius($panel-border-radius);
    @include border-bottom-radius($panel-border-radius);
}
```
6. Refresh your test page preview to view the changes.
   When you select a search result, the item opens in the embedded SC Catalog Item widget.

![SC Catalog Item Widget](image)

Create a reusable directive and add it to a widget

Angular Providers are reusable components that can be added to multiple widgets. Using the Widget Angular Providers table, create a directive that shows a category icon next to each result in the Quick Order widget.

Role required: admin or sp_admin

Angular Providers let you build angular directives and services that can be injected into your client script controller. The code in a Provider differs from a typical Angular directive or service because it must be anonymous, without being appended to a specific module.

   The Widget Angular Providers table opens.
2. Click New to create a new record.
3. Fill out the form.
   a) Add the type and name.
      • Type: Directive
      • Name: categoryIcon
   b) Add the client script.

```javascript
function() {
    return {
        template: '<span class="fa fa-stack fa-lg"><i class="fa fa-circle fa-stack-2x"></i><i class="fa fa-{{::icon}} fa-stack-1x fa-inverse"></i></span>',
    }
}
```
restrict: 'E',
replace: true,
scope: {
    category: '=
}
link: function(scope, element) {

var _iconMap = {
    "b06546f23731300054b6a3549dbe5dd8": "tablet", /* Tablets */
    "15706fc0a0a0aa7007fc21e1ab70c2f": "question", /* Can we help you? */
    "d68eb4d637b1300054b6a3549dbe5db2": "mobile-phone", /* Mobiles */
    "109cdf8c6112276003b17991a09ad65": "print", /* Office and Print */
    "5d643c6a3771300054b6a3549dbe5db0": "print", /* Printers */
    "2c0b59874f7b4200086eed18110c71f": "plug", /* Peripherals */
    "2809952237b1300054b6a3549dbe5dd4": "desktop" /* Software */
};

scope.icon = _iconMap[scope.category] || "shopping-cart";
}
This script associates the sys_id of the Category record with the Service Catalog item. The icon that displays is the icon defined in the Category record in the Service Catalog.
### Widget Angular Provider

**Type**
- Directive

**Name**
- categoryIcon

**Client Script**
```javascript
function() {
  return {
    template: '<span class="fa fa-stack fa-lg">\<i class="fa fa-circle fa-stack-2x"\></i><i class="fa fa-(\{::icon\}) fa-stack-2x fa-inverse"></i></\span>',
    restrict: 'E',
    replace: true,
    scope: { }
    category: '='
  },
  link: function(scope, element) {
    var _iconMap = {
      '665346442373130094542a03e58e6d93': 'tablet', /* Tablets */
      '23740f1625436f7f21e1c3874c2f': 'question', /* Can we help you? */
      '3b5e4e4d370130094542a03e58e6d93': 'mobile-phone', /* Mobiles */
      '381c7f8c51722708317591e99ad8f3': 'print', /* Office and Print */
      '545845534377130094542a03e58e6d93': 'printer', /* Printers */
      '2cd8598747f7d2000000000000000000': 'plug', /* Peripherals */
      '3999552370130094542a03e58e6d93': 'desktop', /* Software */
    };
    scope.icon = _iconMap[scope.category] || 'shopping-cart';
  }
}
```

**Application**
- Global
c) Click **Save**.

4. **Associate the new Angular directive with the Quick Order Widget.**
   a) Navigate to `<yourInstanceURL>/sp_config?id=widget_editor`.
   b) Open the Quick Order widget.
   c) Under **Related Lists**, select **Angular Providers**.
   d) In the Angular Providers list, click **New** to associate an existing Angular Provider with the Quick Order widget.
   e) Add the following values to the form.
      - **Angular Provider**: categoryIcon
      - **Widget**: Quick Order
   f) Click **Save**.

5. **Add the categoryIcon directive to your Quick Order HTML template.**
   a) From the **Widget Editor**, open the Quick Order widget.
   b) Replace the HTML template with the following script.

```html
<div class="panel panel-primary">
  <div class="panel-heading">Request an item from the catalog</div>
  <div class="panel-body">
    <input class="form-control" type="search" placeholder="Start typing here to search the list of catalog items" ng-model="c.data.keywords" ng-change="c.server.update()" ng-model-options="{debounce: 250}" />
    <h5 ng-if="!c.data.keywords">Showing the most popular items</h5>
    <ul class="list-group result-container">
      <li class="list-group-item" ng-repeat="item in c.data.items">
        <a href ng-click="c.select(item.sys_id)"><category-icon category="item.category" style="margin-right: 10px"></category-icon>{{item.name}}</a><span class="pull-right">{{item.price}}</span><div class="catalog-item" ng-if="item.sys_id == c.openItem">
          <sp-widget ng-if="c.catalogItemWidget" widget="c.catalogItemWidget" />
        </div>
      </li>
    </ul>
  </div>
  <div class="panel-footer" ng-if="c.data.keywords">
    <ng-pluralize count="c.data.items.length" when="{0: 'No items found for ', '1': 'One item matching ', 'other': 'Found () items matching '}">
      {{c.data.keywords}}
    </ng-pluralize>
  </div>
</div>
```

6. Refresh your test page preview to view the changes.
   A category icon displays beside each result.

![Request an item from the catalog](image)

### Widget API reference

Service Portal includes client and server side APIs to use in widget client and server scripts.

### Service Portal client-side APIs

These are Service Portal APIs that you can use in a widget client controller. See the API reference for detailed class and method information.

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>spAriaUtil</td>
<td>Show messages on a screen reader.</td>
</tr>
<tr>
<td>spContextManager</td>
<td>Make data from a Service Portal widget available to other applications and services in a Service Portal page. For example, pass widget data to Agent Chat when it opens in a Service Portal page.</td>
</tr>
<tr>
<td>spUtil</td>
<td>Utility methods to perform common functions in a Service Portal widget client script.</td>
</tr>
<tr>
<td>spModal</td>
<td>Show alerts, prompts, and confirmation dialogs in Service Portal widgets. The SPModal class is available in Service Portal client scripts.</td>
</tr>
</tbody>
</table>

**Note:** g_form as a global object cannot be used in a widget client controller or in a UI script.
Service Portal server-side APIs

These are Service Portal APIs that you can use in a widget server script.

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlideSPScriptable</td>
<td>Interact with data and perform record operations in Service Portal widgets.</td>
</tr>
<tr>
<td>GlideSPSearchAnalytics</td>
<td>Generate search analytics from custom Service Portal search widgets.</td>
</tr>
<tr>
<td>spScriptedFacet</td>
<td>Define facet items, filters, or mapped queries for a facets object.</td>
</tr>
<tr>
<td>spScriptedFacetService</td>
<td>Generate a multi choice or single choice facets object for an advanced search source.</td>
</tr>
</tbody>
</table>

Widget properties

Global variable and functions available in widget client and server scripts.

Server script global objects

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>input</td>
<td>An object containing client-side properties set under c.data. The value is undefined until the client controller calls c.server.update().</td>
</tr>
<tr>
<td>data</td>
<td>An object containing properties set during server-side execution.</td>
</tr>
<tr>
<td>options</td>
<td>An object containing the schema option properties.</td>
</tr>
</tbody>
</table>

Client script global functions

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>this.server.get([Object])</td>
<td>Calls the server and sends custom input. Returns Promise.</td>
</tr>
<tr>
<td>this.server.update()</td>
<td>Calls the server and posts this.data to the server script. Returns Promise.</td>
</tr>
<tr>
<td>this.server.refresh()</td>
<td>Calls the server and automatically replaces the current options and data from the server response. Returns Promise.</td>
</tr>
</tbody>
</table>

A promise represents the eventual result of an asynchronous operation. For more information on promises, see [https://promisesaplus.com/](https://promisesaplus.com/) or AngularJS documentation.

Widget troubleshooting guide

Use the following tools to investigate and resolve unexpected behavior in your custom Service Portal widgets.
Reduce complexity

Deactivate widgets unrelated to the widget you are troubleshooting to isolate parts of the page that may be causing errors or unexpected behavior. Set the active field to false on a widget record to hide the widget on the page, and prevent associated scripts from executing.

Use the browser developer console

All supported desktop browsers have built in developer tools. Access your browsers developer tools to view console messages and errors thrown by client-side javascript. Many of the logging tools detailed below output information to this console.

Use the widget context menu to access information and options

CTRL+right-click a widget to access configuration options for the widget. There are also options to output the scope and scope data object to the browser console. For more detail on this menu , see Widget context menu.

Use script methods to capture debugging output

Several methods are available to output debugging information within your server and client-side code.

Scripted debugging methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Availability</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>console.log()</td>
<td>Server and client</td>
<td>Logs output to the browser developer console.</td>
</tr>
<tr>
<td>$sp.log()</td>
<td>Server</td>
<td>Logs output to the Service Portal Log Entries [sp_log] table, when the logged in user has the sp_admin or admin role.</td>
</tr>
<tr>
<td>gs.log()</td>
<td>Server</td>
<td>Logs output to the Log [syslog] table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: gs.log creates records on the syslog table. Excessive use can adversely affect performance.</td>
</tr>
<tr>
<td>gs.warn()</td>
<td>Server</td>
<td>Produces warning level output in the Log [syslog] table.</td>
</tr>
<tr>
<td>gs.error()</td>
<td>Server</td>
<td>Produces error level output in the Log [syslog] table.</td>
</tr>
<tr>
<td>gs.addInfoMessage()</td>
<td>Server</td>
<td>Displays a green information message at the top of the browser window.</td>
</tr>
<tr>
<td>gs.addErrorMessage()</td>
<td>Server</td>
<td>Displays a red error message at the top of the browser window.</td>
</tr>
<tr>
<td>spUtil.addErrorMessage()</td>
<td>Client</td>
<td>Displays an error message within the browser window.</td>
</tr>
<tr>
<td>spUtil.addInfoMessage()</td>
<td>Client</td>
<td>Displays an Info message within the browser window.</td>
</tr>
<tr>
<td>spUtil.addTrivialMessage()</td>
<td>Client</td>
<td>Displays a message which automatically disappears after a short time.</td>
</tr>
<tr>
<td>debugger</td>
<td>Client</td>
<td>Sets a break point in Chrome and Firefox browsers, allowing you to step through a script line by line in the browsers developer console.</td>
</tr>
</tbody>
</table>
### Method

<table>
<thead>
<tr>
<th>Method</th>
<th>Availability</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{{(data)}json}</td>
<td>HTML</td>
<td>This code can be added to the HTML code of a page to output the data object to the portal page in JSON format.</td>
</tr>
</tbody>
</table>

### Check for security restrictions

Often, widget display issues are caused by access rules rather than the widget script. Verify that any records that are not accessible within a widget are accessible using the platform UI. Use the ACL debugger to ensure that your users have the expected access to records used by your widgets. For more detail on the debugger, see [ACL debugging tools](#).

### Create a reference to the widgets scope in the console

Use reference to a widget to manipulate scope data or manually run the widgets client and server scripts. Use the following steps to create the reference.

1. Right-click the widget and choose **Inspect**.
2. In dev tools Elements tab, click to highlight the element with attribute `widget=widget`. You can find it a few elements above the currently inspected element. This element points the $0 scripting tool at the widget.
3. In the Javascript console, run the following code:

   ```javascript
   var scopeRef = angular.element($0).scope();
   ```

Use the reference to your widget to change data within the console. See the following example. Remember to run AngularJS `$apply()` on the scope to apply changes to the page.

```javascript
scopeRef.data.prop1 = "Pear";
scopeRef.$apply();
```

Run any function defined in the widgets client controller from your reference using the syntax below.

```javascript
scopeRef.exampleFunction();
```

Use the refresh command to manually execute the widgets server script.

```javascript
scopeRef.server.refresh();
```

### Service Portal search

Service Portal displays search data within a widget on the search page. To make data searchable from Service Portal, create a search source that fetches data from a single table within your ServiceNow instance, from multiple ServiceNow tables, or from an external site. Configure search options or build custom search components.

### Search sources

A search source is a record that describes the behavior and source of searchable data. A search source defines:

- Where to retrieve search data from.
- Whether search suggestions can populate the search field based on user input.
• How a search entry displays in the search result page.

Search sources have simple and advanced configurations.

**Simple**

Define a table within your ServiceNow instance as a source of searchable data. To learn more, see [Define a search source](#).

**Advanced**

Define a data fetch script to return data. A data fetch script executes on the server and returns a result array to the search widget. This method is more complex, but offers complete power over how a search executes. You are not limited to querying single tables within ServiceNow and can define a script that fetches data from multiple tables, or from anywhere on the web. To learn more, review the [Tutorial: set up an external knowledge base search source](#).

> **Note:** Search facets may not behave as expected if integrated into an advanced search source that queries data from a non-ServiceNow site.

**Text index groups**

A text index group defines how users see search results. For example, combine search results from several sources, or set the weight of certain fields. Text index groups are a Now Platform feature. To learn more, see [Configure multiple tables for indexing and searching](#).

Associate a portal with a text index group to create common search rules and to combine search results from all search sources in the group. If you have a custom search source or portal, consider whether you want to use the base system `portal_index_group` text index group, or create your own text index group. The base system text index group includes the Catalog items, Knowledge, and Social Q&A Questions tables. When a user searches for an item in Service Portal, they see combined results from these tables. To add an index group to a portal, see [Add a text index group to a portal](#).

> **Note:** Text index groups do not support external search sources.

**Typeahead settings**

Typeahead returns search results as a user types in the search field. You can configure typeahead settings, or disable the feature entirely, within the search source record.

**Simple**

Define an icon to display beside typeahead results and the target page to display typeahead selections.

**Advanced**

Define a template for the typeahead result. See [Create an advanced typeahead template](#).

**Search facets**

Enable your end users to filter search results for a more meaningful result set. Facets can return results based on:

• Fields in a table such as **Active** or **Author**.
• Query conditions such as [Updated][After][Last week].

**Note**: Only set search facets for indexed fields. Fields that are not indexed may take longer to return results and are not optimized for a fast search experience. Learn more: Enable text indexing for a table.

Search facets render in the Faceted Search widget on the sp_search page. In new instances, search facets are enabled by default. If upgrading from a previous release, enable search facets by activating a record in the Page Route Maps [sp_page_route_map] table. See Enable search facets.

**Simple**

Enable end users to refine search results for a simple search source. You can create facets for a table search source that return results based on field values or query conditions. See Add facets to a simple search source.

**Advanced**

Define facets for advanced search sources using the **Facet generation script** on the search source record. Use facet APIs to create facets and assign ServiceNow facet items or mapped queries to the facet.

<table>
<thead>
<tr>
<th>API</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPScriptedFacetService - Scoped</td>
<td>Creates a single or multi choice facet.</td>
</tr>
<tr>
<td>SPScriptedFacet - Scoped</td>
<td>Defines facet items, filters, or mapped queries for the facet.</td>
</tr>
</tbody>
</table>

**Search analytics and suggestions**

Generate relevant search suggestions for your users and monitor search analytics to understand what your users are searching for and whether they’re finding what they need. Search analytics and suggestions is a Now Platform feature. For more information, see Search analytics and suggestions.

**Populate suggestion data on upgrade**

If you are upgrading from a previous release, run a script to populate search suggestions with data from a platform search table to provide search suggestions to your users. For more information, see Populate search suggestions in Service Portal.

**Generate suggestions from custom widgets**

By default, the Search Events [sys_search_event] and Search Source Events [sys_search_source_event] tables collect search data from base system search widgets. To generate search analytics from custom Service Portal search widgets, use the GlideSPSearchAnalytics API. For more information, see GlideSPSearchAnalytics.

**Use suggestions instead of typeahead search**

Search suggestions replaces typeahead search in Service Portal. Update the `glide.service_portal.search_as_you_type_behavior` system property to change this behavior. For more information, see Enable and disable search suggestions. Service Portal search widgets automatically use whichever feature you enable.
Search configurations

When you create a simple search source, Service Portal uses the search engine settings configured on your instance. To learn more, see Search administration.

Performance recommendations

To avoid performance degradation and to ensure a fast search experience for end users, follow these recommendations.

- Limit search sources when possible to perform only the necessary query. For example, if a search only needs to return active incidents, add a condition to the search source set to `[Active] [is] [true]`. A search that queries only active incidents is faster than a search that queries all records in the incident table.
- Create facet items and mapped queries with no more than 30 filter items. To verify, test each search source with a variety of keywords as a user with low permissions.

Note: Service Portal search results display as text only. HTML tags, images, and formatting do not display in search results.

Define a search source

Configure a basic search source to query data from an instance table, or configure an advanced data fetch script to query data across multiple tables and data sources, or to pull data from anywhere on the web.

1. In the platform UI, navigate to Service Portal > Portals and select the portal you want to add search sources to.
2. From the Search Sources related list, click New to add a search source.
3. Define the fields on the Search Source form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The display value for the search category.</td>
</tr>
<tr>
<td>ID</td>
<td>The record ID. The value should be unique, and should not include any spaces or special characters.</td>
</tr>
<tr>
<td>Application</td>
<td>The scope of the search source.</td>
</tr>
<tr>
<td>Roles</td>
<td>If the Service Portal User Criteria Support plugin is not enabled, define user roles to access this search source.</td>
</tr>
<tr>
<td>Search page template</td>
<td>The HTML template that displays the search results. If defining a basic search source, you do not need to change the default template. For an example of a modified template, see Tutorial: set up an external knowledge base search source.</td>
</tr>
</tbody>
</table>

4. Complete the fields on the Data Source tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is scripted source</td>
<td>Adds an advanced data fetch script. If configuring an instance table as the data source, do not check this option.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Data fetch script</td>
<td>Script defining the endpoint and API calls to fetch data. This field is only visible when <strong>Is scripted source</strong> is selected. For an example of a data fetch script, see Tutorial: set up an external knowledge base search source.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If defining a facet generation script, inject the facets object into the data fetch script and update the script to generate data for each facet item. For an example, see the Knowledge Base and Service Catalog search sources. Search facets may not behave as expected if integrated into an advanced search source that queries data from a non-ServiceNow site.</td>
</tr>
<tr>
<td>Facet generation script</td>
<td>Script defining search facets for a scripted search source. Enable your end users to filter search results for a more meaningful result set. This field is only visible when <strong>Is scripted source</strong> is selected.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If defining a facet generation script, inject the facets object into the data fetch script and update the script to generate data for each facet item. For an example, see the Knowledge Base and Service Catalog search sources. Search facets may not behave as expected if integrated into an advanced search source that queries data from a non-ServiceNow site.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table from the list that you want to draw your results from. You can select any table in the platform. For example, User [sys_user] or Knowledge [kb_knowledge].</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only indexed tables return search results. Learn more: Enable text indexing for a table.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Filters results based on defined conditions. For example, Active is True.</td>
</tr>
<tr>
<td>Primary display field</td>
<td>Select which field you want to display on the search results page. For example, Name.</td>
</tr>
<tr>
<td>Display fields</td>
<td>Select additional fields to display on the search results page. For example, User ID, Email, and City.</td>
</tr>
<tr>
<td>Paginate results</td>
<td>Paginates search results. True by default. If <strong>Is scripted source</strong> is selected, the value updates to false. To enable pagination for a scripted search source, see <strong>Paginate search source results</strong>. Define the maximum number of results per query for the search source in the Search Page widget or Faceted Search widget instance options.</td>
</tr>
</tbody>
</table>

5. Configure **Typeahead** settings to allow search results to populate the search field based on user input.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable typeahead</td>
<td>Allows typeahead functionality. If you do not want to integrate typeahead into your search source, clear the check box.</td>
</tr>
<tr>
<td>Advanced typeahead config</td>
<td>Optionally add an advanced typeahead script to configure the way search results display. For more information, see Create an advanced typeahead template.</td>
</tr>
<tr>
<td>Typeahead glyph</td>
<td>Adds an icon beside each typeahead result.</td>
</tr>
</tbody>
</table>
6. Click **Submit**.

To enable end users to refine search results, **Add facets to a simple search source**.

### Paginate search source results

Limit the number of results that a search source displays at one time to improve performance. End users can load more results as needed.

**Role required:** admin or sp_admin

If adding pagination to a simple search source, set **Paginate results** on the search source record to true. However, if adding pagination to an advanced search source, you must also modify the data fetch script to handle multiple pages of results. When a user loads more search results, the search source re-executes the data fetch script.

**Note:** If paginating a search source with advanced facets, do not modify the facet generation script to load facets based on the results from each page. Facets should enable end users to filter results from an entire result set, rather than page-specific results.

1. **In the platform UI**, navigate to **Service Portal > Search Sources**.
2. **Open a search source** to add pagination to.
3. **Set** **Paginate results** to true.

   Enabling this field adds a **Load more results** button to the search results page. This flag automatically enables pagination for simple search sources.

4. **Optional:** If the search source is advanced, modify the data fetch script to handle multiple search result pages.

   Update the data fetch script using one of the following GlideRecord APIs, depending on the scope of the search source.
The following is an example data fetch script for a global search source that queries the incident table and paginates results.

```javascript
(function(query, queryLocation, count) {
  var results = [];
  var now_GR = new GlideRecord("incident");
  now_GR.addQuery("123TEXTQUERY321", query);
  now_GR.query();
  // Here, we are utilizing queryLocation to implement pagination.
  // In practice, there are many other ways to use the
  // query_location value of the last item in the previous
  // result set to implement pagination. Your implementation
  // will vary by use case.
  now_GR.setLocation(queryLocation - 1);

  var resultCount = 0;
  while(now_GR.next() && resultCount < count + 1) {
    results.push({
      label: now_GR.getDisplayValue(),
      short_description: now_GR.getValue("short_description"),
      // Here, we are populating the query_location
      // property of each result item. This is how the
      // framework knows what value to pass into the
      // next fetched search result script execution
      query_location: now_GR.getLocation(),
      primary: now_GR.getDisplayValue(),
      state: now_GR.getDisplayValue("state")
    });
    resultCount++;
  }

  if (results.length == 0)
    return results;

  if(results.length > count) {
    results.pop();
  } else {
    // In order to indicate that a result in the result
    // set is the final result (that there are
    // no more results to be fetched), add this property
    // to the final element in your result set.
    results[results.length - 1].isLastResult = true;
  }
  return results;
})(query, queryLocation, count, facets);
```

For an additional example, see the Knowledge Base search source.

5. Define the maximum number of results per query for the search source in the Search Page widget or Faceted Search widget instance options.
The search page only returns the defined number of results at one time. When a user selects **Load more results**, the search source re-executes the query or data fetch script.

**Create an advanced typeahead template**

Configure the way typeahead results display with an advanced template.

1. Complete the required fields in **Define a search source**.
2. In the **Typeahead** tab of the **Search Source** record, select the **Advanced typeahead config** check box.
3. In the **Typeahead template** field, add an HTML template.

   This example uses AngularJS bindings to display service catalog images in the typeahead results.

   ```html
   <i class="ta-img" ng-if="match.model.type=='sc'" style="background-image:url('{{match.model.picture}}')"></i>
   ```
4. Click Update.

Typeahead results display beside the image defined in the service catalog record.

**Tutorial: set up an external knowledge base search source**

Define an advanced search source to return data from any source on the Internet. To understand the power of search sources, follow this tutorial to set up an external knowledge base search source.

To create an advanced search source, you need an external resource that you can access via REST and basic knowledge of AngularJS.
In this integration, you will:

- Create a data fetch script that uses the ServiceNow Table API to query a knowledge base from another ServiceNow instance.
- Decode the JSON response and define the fields that the search widget expects.
- Update the search sources HTML template to open the search result in the external site.

1. In the platform UI, navigate to **Service Portal > Portals** and select the portal you want to add the search source to.
2. From the **Search Sources** related list, click **New**.
3. Create a name and ID for the search source. The ID should be unique, and should not include any spaces or special characters.
4. On the **Data Source** tab, select the **Is scripted source** check box.
5. Add content to the data fetch script field.
   a) Define the search function to be executed by the instance.

   This example uses a recordless RESTMessenger, but you can modify this example to use a pre-configured #unique_2948 if needed, or create a more secure authentication profile.

   ```javascript
   (function(query) {
   var results = [];
   /* Calculate your results here. */
   var url = "https://myInstance.service-now.com/api/now/table/
   kb_knowledge?sysparm_query=GOTO123TEXTQUERY321%3D" + encodeURI(query)
   + ":&sysparm_fields=sys_id%2Cnumber%2Cshort_description%2Ccategory%2Ctext";
   var ws = new sn_ws.RESTMessageV2();
   ws.setBasicAuth("search_user", "search");
   ws.setHttpMethod("get");
   ws.setEndpoint(url);
   var jsonOutput = ws.execute();
   return results;
   })(query);
   
   Note: In the preceding example, `ws.setBasicAuth` requires a user and password for the remote instance. For more detail, see RESTMessengerV2 - Scoped, Global.
   
   b) Add an if statement to the data fetch script to decode the JSON object being returned, iterate over each result, and set expected fields.

   The final data fetch script:

   ```javascript
   (function(query) {
   var results = [];
   /* Calculate your results here. */
   var url = "https://<my-instance>.service-now.com/api/now/table/
   kb_knowledge?sysparm_query=GOTO123TEXTQUERY321%3D" + encodeURI(query)
   + ":&sysparm_fields=sys_id%2Cnumber%2Cshort_description%2Ccategory%2Ctext";
   var ws = new sn_ws.RESTMessageV2();
   ws.setBasicAuth("search_user", "search");
   ws.setHttpMethod("get");
   ws.setEndpoint(url);
   var jsonOutput = ws.execute();
   if (jsonOutput) {
   var response = new JSON().decode(jsonOutput.getBody());
   ```
results = response.result;
results.forEach(function(result) {
    result.url = "https://myInstance.service-now.com/
    kb_view.do?sysparm_article=" + result.number;
    result.target = "_blank";
    result.primary = result.short_description;
});

if (jsonOutput.haveError()){
    gs.addErrorMessage(jsonOutput.getErrorMessage());
}
return results;
})(query);

In this example, the following fields are set on the result object:

- **url**: If linking to an external site rather than opening the record in your ServiceNow instance, this defines where the link leads to.
- **target**: The target for the link. Set the target to _blank to open results in a new tab, otherwise leave it blank.
- **primary**: The primary field displayed in the search results.

6. **Update the search page template to open the search results in the external site.**

    <div>
      <a href="https://myInstance.service-now.com/kb_view.do?sysparm_article={{item.number}}" target="_blank" class="h4 text-primary m-b-sm block">
        <span ng-bind-html="highlight(item.primary, data.q)"></span>
      </a>
      <span class="text-muted" ng-repeat="f in item.fields | limitTo: 4">
        <span class="m-l-xs m-r-xs" ng-if="!$first"> &middot; </span>
        {{f.label}}: <span ng-bind-html="highlight(f.display_value, data.q)"></span>
      </span>
    </div>

7. **Click Update.**

    Test the external search in your portal. Results display under the name field value defined in step three.
Each search result opens in the external site defined in the search page template.
**Example: set up a GitHub search source**

Set up an advanced search source that queries data from an external site.

To create an advanced search source, you need an external resource that you can access via REST and basic knowledge of AngularJS.

1. In the platform UI, navigate to **Service Portal > Portals** and select the portal you want to add search sources to.
2. From the Search Sources related list, click New.
3. Create a name and ID for the search source.
   The ID should be unique, and should not include any spaces or special characters.
4. On the Data Source tab, select the Is scripted source check box.
5. Add content to the data fetch script field.
   To set up a GitHub integration:

   ```javascript
   (function(query) {
     var results = [];
     /* Calculate your results here. */
     var url = "https://api.github.com/search/repositories?q=" + encodeURI(query);
     var ws = new GlideHTTPRequest(url);
     ws.setBasicAuth("YOUR_USERNAME_HERE", "YOUR_PASSWORD_HERE");
     var jsonOutput = ws.get();
     if (jsonOutput) {
       var response = new JSON().decode(jsonOutput.getBody());
       results = response.items;
       results.forEach(function(result) {
         result.url = result.svn_url;
         result.target = "_blank";
         result.primary = result.full_name;
       });
     }

     return results;
   })(query);
   }

   6. Use the Search page template to customize the way the search results display.

   ```html
   <div>
     <div class="pull-right">
       <strong>{{item.language}}</strong>
       <a ng-href="{{item.svn_url}}/stargazers" target="_blank" class="m-l-sm"><span class="fa fa-star m-r-xs"></span>{{item.stargazers_count}}</a>
       <a ng-href="{{item.svn_url}}/network" target="_blank" class="m-l-sm"><span class="fa fa-code-fork m-r-xs"></span>{{item.forks}}</a>
     </div>
     <a ng-href="{{item.svn_url}}" target="_blank" class="h4 text-primary m-b-sm block">
       <span ng-bind-html="highlight(item.full_name, data.q)"></span>
     </a>
     <p>{{item.description}}</p>
     <p>Updated <sn-time-ago timestamp="item.updated_at"></sn-time-ago> ago</p>
   </div>
   ```

**Enable search facets**

In new instances, search facets are enabled by default. If upgrading from a previous release, enable search facets by activating a record in the Page Route Maps [sp_page_route_map] table.

Role required: admin or sp_admin

Search facets render in the Faceted Search widget on the sp_search page. To enable search facets after upgrade, activate the page route map record to route your search results to render in the sp_search page.

1. Navigate to Service Portal > Page Route Maps.
2. Locate the Search record in the list.
   This record redirects users from the search page to the sp_search page when viewing search results in Service Portal. The sp_search page includes the Faceted Search widget, which supports search facets in both desktop and mobile environments.

3. Set the Active field to true.

When using search in Service Portal, results render in the sp_search page. Add facets to the search source to enable end users to filter search results. To learn more about facets, see Add facets to a simple search source.

Add facets to a simple search source

Enable end users to refine search results for a simple search source. You can create facets for a table search source that return results based on field values or query conditions.

Role required: admin or sp_admin

In new instances, search facets are enabled by default. If upgrading from a previous release, enable search facets by activating a record in the Page Route Maps [sp_page_route_map] table. See Enable search facets. Create facet items and mapped queries with no more than 30 filter items. To verify, test each search source with a variety of keywords as a user with low permissions.

Note: Only set search facets for indexed fields. Fields that are not indexed may take longer to return results and are not optimized for a fast search experience. Learn more: Enable text indexing for a table.

1. Navigate to Service Portal > Search Sources.
2. Open or create a simple search source.
   Simple search sources do not use a data fetch script. Rather, they define a table as the source of searchable data. To learn more about search sources, see Service Portal search.
3. Select the Facets related list.
4. Click New.
   The Facet form displays.
5. Complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name of the facet header.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the search source. This value is read-only.</td>
</tr>
<tr>
<td>Selection type</td>
<td>Type of user selection allowed:</td>
</tr>
<tr>
<td></td>
<td>• Single: Only one filter value can be selected at a time. For example, if</td>
</tr>
<tr>
<td></td>
<td>a facet is created for the Assigned to field, the end user can select</td>
</tr>
<tr>
<td></td>
<td>Fred Luddy or Beth Anglin, but not both at the same time. Before filtering</td>
</tr>
<tr>
<td></td>
<td>for a new value, the user must first clear the current value.</td>
</tr>
<tr>
<td></td>
<td>• Multiple: Multiple filter values can be selected at the same time. For</td>
</tr>
<tr>
<td></td>
<td>example, if a facet is created for the Assigned to field, the end user can</td>
</tr>
<tr>
<td></td>
<td>select both Fred Luddy and Beth Anglin. Because multi choice results in an</td>
</tr>
<tr>
<td></td>
<td>OR query, records assigned to either Fred Luddy or Beth Anglin display.</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the filter option displays in search results.</td>
</tr>
</tbody>
</table>
Use mapped facet filters | Maps a facet to a query condition, such as `[Updated][After][Last week]`. When selected, the **Fields** and **Sort** fields are removed from the form. After saving, define filters in the Facet Filters related list.

Order | Defines the display order when multiple facets are defined. If some facets do not have an order value defined, facets with an order defined display first. Facets without an order defined are displayed alphabetically.

Table | Table that the query is created for. This value is read-only and defined by the table used in the search source.

Field | Field that end users can filter search results by. For example, if **Active** is selected, the user can filter search results by true or false. Only fields of the following types are supported: True/False, Choice, Decimal, Floating Point Number, Integer, IP Address, Long, Reference, String, String (Full UTF-8), and URL.

Sort | Determines the order in which filter options display. - **Ascending**: Sorts filter options from A to Z when alphabetical, and from lowest to highest when numerical. This is the default option. - **Descending**: Sorts filter options from Z to A when alphabetical, and from highest to lowest when numerical.

6. Save the record. If **Use mapped facet filters** is selected, the **Facet Filters** related list appears in the facet form.

7. Optional: If **Use mapped facet filters** is selected, define facet filters. Map facet filters map a query condition to a facet label. When the end user selects the label from the facet list, the defined query executes.

a) In the **Facet Filters** related list, click **New**. The Mapped Facet Form appears.

b) Define the facet filter fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name of the facet filter option.</td>
</tr>
<tr>
<td>Order</td>
<td>Defines the display order when multiple facet filters are defined. If some facet filters do not have an order value defined, facets filters with an order defined display first. Facet filters without an order defined are displayed alphabetically.</td>
</tr>
<tr>
<td>Application</td>
<td>The application scope of the search source. This value is read-only.</td>
</tr>
<tr>
<td>Facet</td>
<td>The search facet that uses the mapped query. This value is read-only.</td>
</tr>
<tr>
<td>Table</td>
<td>The table defined in the search facet. This value is read-only.</td>
</tr>
<tr>
<td>Mapped query</td>
<td>A query condition that users can set to filter search results. For example, <code>[Updated][On][Today]</code>.</td>
</tr>
</tbody>
</table>
c) Click Submit.
Users can filter search results based on the query defined.

**Disable facets for a search source**

Disable facets for one or more search sources by adding a system property. Once disabled, the search source does not display search facets in the Faceted Search widget on the sp_search page. You can disable facets for simple or advanced search sources.

Role required: admin or sp_admin

1. Enter sys_properties.list in the Application Navigator to navigate to the System Properties table.
2. Click New.
The System Property form opens.
3. In the Name field, enter glide.service_portal.disable_facets_for_search_sources.
4. In the Value field, enter a comma-separated list of search source Sys IDs to disable facets for. Do not include spaces. For example, c6170ae86721220023c82e08f585efe6,c96eb1686721220023c82e08f585efff.
5. Click Submit.

Facets do not display when the defined search source is selected in the sp_search page.

**Populate search suggestions in Service Portal**

If you are upgrading from a previous release, run a script to populate search suggestions with data from a platform search table to provide search suggestions to your users. Alternatively, you can wait until users search for keywords instead of running this script.

Role required: admin

In new instances, the search suggestions are enabled by default. In upgraded instances, you must enable the search suggestions. For more information, see Enable search suggestions.

The Now Platform collects search data and analytics that generate search suggestions. If you are upgrading from a previous release, the search analytics do not contain any data yet. To immediately provide suggestions to your users, you can populate the search suggestions using data from either the Text Searches [text_search] table or the Service Portal Log Entries [sp_log] table. The Service Portal Log Entries table includes search data from Service Portal only and may take less time to populate search suggestions. The Text Search table includes search data from the entire platform.

Search suggestions improve over time as more people use Service Portal. Search analytics and suggestions is a Now Platform feature. For more information, see Search analytics and suggestions.

**Caution:** Populating search suggestions can be a resource-intensive task that may take a while to complete. Do not run this script during peak hours. Populating search suggestions is not supported on domain-separated instances.

1. Navigate to System Definition > Scheduled Jobs.
2. Open the Populate Suggestions to avoid Cold Start - Portals scheduled job.
3. Modify the script for your search implementation.
   a) Define which portals the suggestions apply to. By default, the script populates suggestions in the base system service portal, but you can add as many as you want to the array.

   ```javascript
   var portals = ["Service Portal"];
   ```

   b) Change where the data comes from. By default, the script imports data from the Text Searches [text_search] table, but you can change the source table to the Service Portal Log Entries [sp_log] table. The Service Portal Log Entries only saves records from the last 90 days.

   ```javascript
   var searchLogTable = "text_search";
   ```

   c) Push data to any custom search sources in your instance. Suggestions are not enabled for external search sources. You must push data to both the search source name and the Sys ID. For example, push text searches from the Incident table to your custom Incident search source. For more information about custom search sources, see Define a search source. By default, the system pushes text searches from the Catalog, Knowledge, and Social Q&A Questions tables to the respective search sources.

   Add the following code after line 11 in the script for each of your custom search sources.

   ```javascript
   searchSources.push("<search-source-table-name>");
   searchSourceIds.push("<search-source-sys-id>");
   ```

   If the search source table does not exist, the system does not push suggestions to that search source.

   d) Save the record.

   Make sure that the script includes the configuration you need. You can only run the script once.

4. Activate the record and select Execute Now.
   Running this scheduled job populates the Search Events [sys_search_event], Search Source Events [sys_search_source_event], and Search Suggestions [sys_search_suggestion] tables.

   Users see suggestions when they start typing in a Service Portal search widget.

**Add a text index group to a portal**

Define how users see search results. For example, combine search results from several sources, or set the weight of certain fields.

Role required: admin

If you have a custom search source or portal, consider whether you want to use the base system `portal_index_group` text index group, or create your own text index group. The base system text index group includes the Catalog items, Knowledge, and Social Q&A Questions tables. When a user searches for an item in Service Portal, they see combined results from these tables.

**Note:** Index tables before adding them to a text index group. To learn more about text indexing, see Enable text indexing for a table.

Text index groups are a Now Platform feature. To learn more, see Configure multiple tables for indexing and searching.
Note: Text index groups do not support external search sources.

1. Navigate to Service Portal > Portals.
2. Open the portal that you would like to add a text index group to.
3. Configure the form to add the Text Index Group field.
4. Add the text index group you want to the Text Index Group field.

Search results display according to the text index group’s rules.

Set the default portal search source

Use the glide.service_portal.default_search_sources system property to define default search sources.

Role required: admin

If you don’t define specific search sources for your portal, the system uses default search sources instead.

Default search source flow chart

1. In the Navigation filter, enter sys_properties.list.
   The entire list of properties in the System Properties [sys_properties] table appears.
2. On the list, find the system property glide.service_portal.default_search_sources, and then open the property record.
3. Copy the sys_ID of any search source you want to add into the Value field of the system property using a comma-separated list.

To change the order in which the default search sources show in the Search List, change the order of the IDs in the property.

You can remove the default search source behavior by deleting the property value or deleting the property altogether.

4. Click Update.

**Configure Search Sources available on a page**

Use contextual search to limit search results for an instance of the type-ahead search widget.

With contextual search enabled, users only see type-ahead results for specific search sources. For example, searching on the Service Catalog page only shows results from the Service Catalog search source when contextual search is enabled.

1. In the Service Portal Designer (Service Portal > Service Portal Configuration > Service Portal Designer), find an instance of the type-ahead search widget.

2. Point to the widget and click the edit icon.

   Alternatively, in any preview page containing the type-ahead search widget, for example the Service Catalog homepage, control + right-click to open the widget context menu. Then click Instance Options.

3. In the Contextual Search Sources field, select search sources from the list.

Search sources listed for contextual search can be limited to just one, several, or all search sources.

Default search sources are defined in the glide.service_portal.default_search_sources property, so even if you do not have search sources configured, type-ahead search widget still shows type-ahead suggestions. For more information on default search sources, see Set the default portal search source.

**Service Portal announcements**

Use announcements to broadcast messages to Service Portal users. Announcements can display in an announcement banner or an announcement widget instance.

Announcements are active on new instances. To activate announcements after upgrade, you can activate the Service Portal Announcements plugin (com.glide.service-portal.announcements).

When creating announcements, you can define the way an announcement displays.

**Sort order**

Announcements are displayed depending on the order defined in:

- The glide.service_portal.announcement.default.sort_order system property. See Service Portal properties.
- The Display First field in the announcement record.

If there is a tie between two records set to Display first, the sort order defined in the system property is honored.

**Display location**

Announcements can display in the following locations:
• Announcement banner
• Announcements widget instance
To define the announcement display location, define the announcement type in the announcement record.

**Display Style**

Using display styles, you can:

- Create a custom color scheme.
- Change the text alignment.

Announcements that appear in a banner use the display style defined in the Announcement record by default. To use the display style in an instance of the Announcements widget, you can select the **Use Display Style** instance option.

**User criteria**

If user criteria is set up for the Service Portal, you can define who can and who cannot view an announcement. Through user criteria, you can create announcements only visible to specific users, groups, roles, organizations, and more.

**Create an announcement**

Announcements display as a banner in a Service Portal or within the announcements widget.

Role required: admin, sp_admin, or announcement_admin

1. Navigate to **Service Portal > Announcements**.
   The Announcements table [announcement] displays all announcements.
2. Click **New**.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Internal title that does not display in the announcement.</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the announcement is active. Inactive announcements do not display.</td>
</tr>
<tr>
<td>Title</td>
<td>The display title of the announcement.</td>
</tr>
<tr>
<td>From</td>
<td>Date and time the announcement begins to display.</td>
</tr>
<tr>
<td>To</td>
<td>Date and time the announcement ends. If this field is not defined, the announcement continues to display until it is deactivated.</td>
</tr>
<tr>
<td>Summary</td>
<td>The display text of the announcement.</td>
</tr>
<tr>
<td>Display style</td>
<td>Defines the background color, text color, and text alignment of banner announcements. Base system styles include:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Normal</strong>: Blue background and left-aligned, white text. This is the default style.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Urgent</strong>: Red background and left-aligned, white text.</td>
</tr>
</tbody>
</table>

Announcements that appear in a banner use the display style defined in the Announcement record by default. To use the display style in an instance of the Announcements widget, you can select the **Use Display Style** instance option.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Type        | Defines where an announcement displays. By default, announcements display in the following locations:  
  • **Banner**: Announcement banner above the banner frame in the Service Portal.  
  • **Widget**: Instance of the announcements widget.  
  You can create an announcement type to define other widget instances to display an announcement. |
| Glyph       | Glyph to display to the left of the title in banner announcements. |
| Glyph alt text | Alternative text for the glyph icon used with screen readers. |
| Public      | Whether the announcement can be viewed before login. |
| Roles       | If **Public** is not selected, you can define roles that the announcement is visible to. If no roles are selected, the announcement is visible to all roles. If **User criteria for Service Portal** is set up and **Public** is not selected, you can define user criteria for the announcement record instead of defining roles. |
| Display first | If selected, the announcement displays before all other announcements.  
  If there is a tie between two records set to **Display first**, the sort order defined in the `glide.service_portal.announcement.default.sort_order` system property is honored. See **Service Portal properties**. |
| Click target | Creates a link below the announcement body that opens to a target page or URL.  
  • **None**: No link is included in the announcement.  
  • **Page**: Opens a Service Portal page in the current browser tab.  
  • **URL in current browser tab**: Opens a URL in the current browser tab.  
  • **URL in new browser tab**: Opens a URL in a new browser tab.  
  If the **Details link text** field is blank and a click target is defined, the title of the announcement is the link. |
| Details page | The page that opens in the current browser tab. Available if the **Click target** is **Page**. |
| Details URL | The URL that opens in the current or new browser tab. Available if the **Click target** is **URL in current browser tab** or **URL in new browser tab**. |
| Details link text | Link text for the page or URL click target. If this field is blank and a click target is defined, the title of the announcement is the link. |
| Dismiss options | Determines whether the user can dismiss the announcement. Options include:  
  • User can dismiss - no redisplay  
  • User can dismiss for current session only  
  • User cannot dismiss |
| Portals     | Portals that display the announcement. If this value is not defined, the announcement displays in all portals. |

4. Save or submit the record.  
5. Optional: If **User criteria for Service Portal** is set up and **Public** is not selected, you can define user criteria for the announcement record. Announcements only display to users that pass the access criteria.  
6. Update the record.
If the Type is Banner, test your announcement by navigating to the portal defined in the Portals field.
If the Type is Widget or a custom type, test your announcement by navigating to the page with the associated widget instance.

Create an announcement display style

Define the background color, foreground color, and text alignment of an announcement.
Role required: admin, sp_admin, or announcement_admin

1. Navigate to Service Portal > Announcements.
2. Open an existing announcement or create a new announcement.
3. In the Display style field, click the reference lookup icon to open the referenced table. The Announcement Styles [announcement_style] list view opens.
4. Click New to create a new display style.
5. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Internal name of the display style.</td>
</tr>
<tr>
<td>Application</td>
<td>The application scope of the announcement. This value is read-only.</td>
</tr>
<tr>
<td>Background color</td>
<td>Color name or HEX value in the format #000000 for the announcement background.</td>
</tr>
<tr>
<td>Foreground color</td>
<td>Color name or HEX value in the format #000000 for the announcement text.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Text alignment. Options include: Left align, Center align</td>
</tr>
</tbody>
</table>

6. Click Submit.

By default, the announcement appears in both the portal banner and the Announcements widget, but only the banner uses your new display style. You can configure the widget to use the display style also. For more information, see the instance options in Announcements widget.

Create an announcement type

Announcement types determine where an announcement displays. Announcements include two base system types: banner and widget.
Role required: admin, sp_admin, or announcement_admin

Similar to creating a category tag, you can create alternative types to define custom locations. For example, to display an announcement only in a specific widget instance, you can create an announcement type for that widget instance. Any announcements tagged with that type will only display in the desired widget instance.

1. Navigate to System Definition > Tables > Announcement Consumer Type. The Announcement Consumer Type table [announcement_consumer_type] opens.
2. In the Columns section of the form, Click New.
3. Define a Name. The name is used to associate an announcement with a widget instance.
4. Click Save.
5. Add the custom type to an announcement.
   a) Navigate to **Service Portal > Announcements**.
   b) Open an existing announcement or create a new announcement.
   c) In the **Type** field, select the custom type.
   d) Click **Save**.

6. If using the type in a widget, define the type as a widget instance option.
   The announcement banner only displays announcements tagged with the **Banner** type.
   a) Navigate to an instance of the Announcement widget.
   b) Control + right-click the widget instance and select **Instance Options**.
   c) In the **Type** field, select the custom announcement type.

The widget instance associated with the type displays any announcements tagged with the same type.

**Service Portal security**

Control user access to a portal.

Control who accesses your portal and what they can see in the following ways:

- **Authentication**: Configure login and single sign on for users
- **Limit page access by role**: Use roles to limit the users who can see a page.
- **Public pages**: Use the **public** check box on a page record to make the page publicly accessible.

**Note**: A number of portal pages that are installed by default are marked public. Filter your list of Service Portal pages for **Public [is] true** to identify these pages. Setting the **Public** value to **false** will prevent these pages from being publicly available.

- **User criteria**: For a more advanced way of limiting user access, create and apply user criteria to pages, widgets, widgets instances, and search sources.
- **Multifactor authentication**: If an instance is configured to require multifactor authentication, users are automatically directed to set up multifactor authentication upon initial login. For setup instructions, see #unique_2956. If multifactor authentication is optional, users can still enable or disable authentication from their user profile. For setup instructions, see #unique_2957.

**Single sign-on, logins, and URL redirects**

Service Portal uses a combination of system properties and script includes to determine how the system handles URL redirects for users logging in to the portal.

Only users who understand SSO, URL redirects, and the ServiceNow platform should make any changes.

**Single sign-on and Service Portal**

To use single sign-on with Service Portal, you must enable the Integration - Multiple Provider Single Sign-On Installer plugin (com.snc.integration.sso.multi.installer).

If you are using the system property to automatically redirect to your primary IdP, then Service Portal automatically redirects to that IdP. If you have multiple identity providers, Service Portal shows a link on the login page to **Use external login**. For more information on SSO and authentication in the platform, see Multiple-Provider single sign-on (SSO).
Require authentication for a Service Portal page

If you want to require authentication for a Service Portal page, ensure that the Public flag on the page record is not selected. For more information, see Create and edit a page using the Service Portal Designer. If a user navigates to a non-public page, they are redirected to the login page for the requested portal.

Because every page request is routed through the $sp page, this page must be public. The following values in the Public Pages sys_public table define the page as public:

- **Page**: $sp
- **Active**: true

Configure the Service Portal login page

Administrators can configure a login page URL redirect for a portal.

1. **Add a system property** with the following settings:
   - Name: glide.entry.page.script
   - Type: string
   - Value:
     ```
     new SPEntryPage().getLoginURL()
     ```

2. To customize the actual entry page, from the Script Includes table, search for SPEntryPage.

   **Note:** If you make changes to the script include, it won't be upgraded with future updates.

3. Edit the script on the SPEntryPage to change the assigned portal to the portal_suffix you want. SPEntryPage uses /sp/ as the portal path to redirect to. Enter your own portal_suffix in place of sp.

   ```
   SPEntryPage.prototype = {
   initialize: function(){
       this.logVariables = false; // for debugging
       this.portal = ""/sp""; // The URL suffix specified in the sp_portal record
   },
   ```

   **Note:** The slash character (/) after /sp may cause issues when configuring single sign-on. If you're experiencing issues, try removing the character from the script.

Redirect to Service Portal after login

Use system properties and script includes to conditionally redirect users to a page after logging in.

Follow these steps to redirect a user to Service Portal after they log in.

1. In the sys_properties table, add the following property:

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.entry.first.page.script</td>
<td>string</td>
<td>new SPEntryPage().getFirstPageURL()</td>
<td>First page after authentication</td>
</tr>
</tbody>
</table>

getFirstPageURL primarily does the following:
• Redirects to `login_redirect.do` in order to break out of the frameset (if there is one).
• Redirects to Service Portal if the user has no roles, or the full platform for everyone else.

2. Customize the after login behavior by navigating to the `SPEntryPage` script include.

   Note: If you make changes to the script include, it won't be upgraded with future updates.

   Note: If you are using external authentication, ensure that your IdP supports the RelayState URL parameter. This parameter retains the originally requested URL while the user authenticates, and is necessary for redirection after login.

Debug Service Portal URL redirects

Debug the URL redirects for logging in to Service Portal and redirecting to the first page.

To view debug output from `SPEntryPage` and see the session variables it redirects based on:

1. Make sure the system property `glide.entry.first.page.script` has the value: `new SPEntryPage().getFirstPageURL()`.
2. From the `SPEntryPage` script include, set `this.logVariables = true`.
3. In a separate browser, log in.
4. From the system navigator, view the log output by navigating to `System Logs > System Log > All`.

Configure page security by role

Set up pages to be public or filter them by role.

Role required: admin or sp_admin

Public pages won't require a user login; anyone can access them. All other options require user authentication.

1. In the Service Portal configuration page (`Service Portal > Service Portal Configuration`), open the Page Editor.
2. In the Select Page list, search for the page to apply page security to.
3. Select the highest level node in the tree view.
4. Configure page security.
   • To make a page public, select the Public check box. All users can access pages marked as Public.
   • To limit access to a certain role, add roles in a comma separated list. Users without the role listed can see links to the page if they appear in the portal. Trying to open the page results in a "page not found" error.

   Note: If you select Public and add a list of roles, the page is still accessible by any user.

   • To create a draft page that only administrators can see while the page is still in development, select Draft. Users must have the admin role to see any pages in draft. Everyone else sees a "page not found" error.

5. Click Save.
Page with limited access by role

Follow the steps in Configure widget security to configure security for the widgets on your page.

**Configure widget security**

Configure widget security to ensure that your widget is being accessed only by the intended audience.

Role required: admin or sp_admin

There are several ways to configure widget security:

- Make the widget public to unauthenticated users
- Make the widget accessible to any user with a login
- Make the widget accessible to certain roles only
When you configure widget security, configure the page security accordingly so that users can access the widget via the page on which it appears. For more information, see Configure page security by role.

1. Navigate to Service Portal > Widgets.
2. Open the record of the widget to configure.
3. On the form, configure the widget security.

<table>
<thead>
<tr>
<th>Option</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make the widget public to unauthenticated users</td>
<td>Select the Public check box.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select Public and add a list of roles, the widget is still accessible by any user.</td>
</tr>
<tr>
<td>Make the widget accessible to any user with a login</td>
<td>Clear the Public check box and leave the Roles field blank.</td>
</tr>
<tr>
<td>Make the widget accessible to certain roles only</td>
<td>a. Clear the Public check box.</td>
</tr>
<tr>
<td></td>
<td>b. Next to Roles, click the edit icon ( ).</td>
</tr>
<tr>
<td></td>
<td>c. On the Roles window, select a role by moving it from the Available list to the Selected list.</td>
</tr>
<tr>
<td></td>
<td>d. Click Done.</td>
</tr>
</tbody>
</table>

4. Click Update.

**User criteria for Service Portal**

User criteria enables you to allow access to users based on role, department, group, location, or company. Administrators can control access to pages, widgets, widget instances, announcements, and search sources in a portal by creating and applying user criteria.

User criteria records define conditions that are evaluated against user records. When user criteria is defined, portal records are only visible to users who pass the defined conditions.

User criteria is a platform feature used in Service Portal. Learn more about user criteria in the Now Platform:

- Service Catalog: Set security for items and categories.
- Knowledge management: Select user criteria for a knowledge base.

**Important:** After making user criteria additions or changes, you may need to log out and back in to clear the prior configuration.

**Converting role-based permissions to user criteria records**

User criteria in Service Portal replaces role-based permissions. After activating the user criteria for Service Portal plugin, you must Set the user criteria for Service Portal system property to true. When the system property is set to true, any existing roles defined for a page, widget, or search source are automatically converted into user criteria records. To disable user criteria and continue using role-based permissions, set the system property to false.
User criteria checks

User criteria uses the following checks in Service Portal to verify user access.

Page access user criteria

The following diagram shows how the system decides whether a user can access a page based on user criteria.
Widget access user criteria

The following diagram shows how the system determines whether a user has access to a particular widget or widget instance.
Activate the user criteria for Service Portal plugin

You can activate the Service Portal User Criteria Support plugin (com.glide.service-portal.user-criteria) if you have the admin role.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Set the user criteria for Service Portal system property

After activating the Service Portal User Criteria Support plugin, you must set the system property to true.

Role required: admin

Setting the system property activates user criteria for Service Portal. When the system property is set to true, any existing roles defined for a page, widget, or search source are automatically converted into user criteria records. To disable user criteria and continue using role-based permissions, set the system property to false.

1. Navigate to Service Portal > Properties.
2. Click the check box to set the following property to true.
   
   Enable use of User Criteria records instead of Roles fields for Service Portal entitlements
   Defines permissions for Service Portal widgets, widget instances, search sources and pages
   
   ✔ Yes | No

3. Click Save.

Create a user criteria record for Service Portal

Create a user criteria record to apply to items in Service Portal and control user access to pages, widgets, widget instances, and search sources.

You can apply existing user criteria to records in Service Portal through Service Portal configuration (Service Portal > Service Portal configuration). You can only create user criteria within the platform UI.

1. In the navigation filter, type Service Portal.
2. Select a page, widget, or widget instance record.
3. In the related list at the bottom of the record, select the Can View or Cannot View tab, then click New.
   If a user criteria record is already created, you can click Edit to apply user criteria to the page, widget, or widget instance.
   User criteria records are stored in the user_criteria table.
4. Complete the fields on the form, as appropriate.

**Service Portal User Criteria**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the criteria record.</td>
</tr>
<tr>
<td>Users</td>
<td>User records to match access criteria.</td>
</tr>
<tr>
<td>Groups</td>
<td>Group records to match access criteria.</td>
</tr>
<tr>
<td>Roles</td>
<td>Roles to match access criteria.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Displays or hides the <strong>Script</strong> field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Script</td>
<td>Defines any additional criteria, and returns true or false. This field is available only if <strong>Advanced</strong> is selected.</td>
</tr>
</tbody>
</table>

**Note:**
- Because scripts are evaluated dynamically, including scripts in user criteria records can decrease performance.
- Do not use a function with its name as answer, that is, answer().

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Application scope for the user criteria record.</td>
</tr>
<tr>
<td>Active</td>
<td>Activate or deactivates this criteria record.</td>
</tr>
<tr>
<td>Companies</td>
<td>Companies to match access criteria.</td>
</tr>
<tr>
<td>Locations</td>
<td>Locations to match access criteria.</td>
</tr>
<tr>
<td>Departments</td>
<td>Departments to match access criteria.</td>
</tr>
<tr>
<td>Match All</td>
<td>Determines whether all elements from each populated criteria field must match. If selected, only users who match all criteria are given access. If cleared, the user must meet one or more of the set criteria to be given access. By default, this check box is cleared so that any condition met provides a match. For example, consider a user criteria record for the following: • Locations A or B • Company C or D With <strong>Match All</strong> selected, only users meeting all these conditions are matched. For example, a user with a location A and a company C. With <strong>Match All</strong> cleared, users meeting any of these conditions are matched. For example, a user with a location B. <strong>Note:</strong> If you select <strong>Match All</strong>, ensure that you do not create contradictory conditions that can never be met. For example, if all users in location A work for company G, then the conditions in this example can never be met.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Apply user criteria to a page, widget, or widget instance**

Assign user criteria to pages, widgets, or widget instances to limit user access to content in a portal.
Activate the Service Portal User Criteria Support (com.glide.service-portal.user-criteria) plugin and set the glide.service_portal.user_criteria_enabled system property to true.

Role required: admin or sp_admin

You can apply several user criteria records to a single portal item.

1. In the Service Portal Configuration page (Service Portal > Service Portal Configuration), open the Page Editor.
2. Select a page from the list.
3. Select a page, widget, or widget instance node from the page tree.
4. Under related lists, click Who Can View or Who Cannot View.
5. Click New.
6. Select a criteria from the Can View or Cannot View list.

Selecting criteria from the Can View or Cannot View list applies user criteria records created in Create a user criteria record for Service Portal to the selected page, widget, or widget instance.

7. Click Save.
Apply user criteria to a search source

Assign user criteria to search sources to limit user access to content in a portal.

Role required: admin
You can add user criteria to custom or default Service Portal search.

1. In the Service Portal Configuration page (Service Portal > Service Portal Configuration), navigate to Portal Tables > Search Source in the header menu.
Service Portal
Create rich, engaging and modern experiences to help your business run. Select one of the options below to continue.

- **Branding Editor**: Customize your portal's title, logo and theme colors. Preview changes as you make them.
- **Designer**: Create and layout pages with drag-and-drop functionality. Preview pages as you make changes.
- **Page Editor**: Configure the properties of pages, containers and widgets from a map view.
- **Widget Editor**: Create widgets from scratch or customize an existing one. Write HTML, CSS, and JavaScript with real-time preview.

**Search Source**: Service Portal
Service Portal Documentation
Service Portal Log Entry
2. Open the search source record that you would like to modify.
3. Under related lists, click **Who Can View Search Sources** or **Who Cannot View Search Sources**.
4. Click **New**.
5. Select a criteria from the **Can View** or **Cannot View** list.

Selecting criteria from the **Can View** or **Cannot View** list applies user criteria records created in **Create a user criteria record for Service Portal** to the selected search source.

6. Click **Save**.

**Enable e-signature for Service Portal**

You can configure e-signature in Service Portal to require re-authentication from approving users.

Role required: admin

2. Navigate to **System Definition > e-Signature Registry**.
3. Add any tables you want to require an e-signature for to the list.
With e-signature enabled, approvers are required to provide a password to approve or reject any requests. Authentication with touch ID works in the mobile app. On the mobile web, approvers are still required to enter a password. For more information on configuring e-signature, see Approval with e-signature.

Service Portal SCSS Primer

SCSS is a subset of the Syntactically Awesome StyleSheets (Sass) specification and is an extension of CSS. Every valid CSS style sheet is valid SCSS.

SCSS variables

SCSS variables are a way to store information that you want to reuse throughout your style sheet. You can store things like colors, font stacks, or any CSS value you think you want to reuse. SCSS uses the $ symbol to make something a variable.

SCSS supports the follow data types:

- Numbers (including units)
- Strings (with quotes or without)
- Colors (name, or names)
- Booleans

Variables can also be arguments to or results from one of several available functions or mixins. During translation, the values of the variables are inserted into the output CSS document.

For example:

```
$font-stack: Helvetica, sans-serif;
$primary-color: #333;

body {  
  font: 100%$font-stack;
  color: $primary-color;
}
```

For more information on Sass, see the Sass/SCSS reference.

SCSS functions

List of functions for Service Portal SCSS compiler.

RGB functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rgb($red, $green, $blue)</td>
<td>Creates a Color from red, green, and blue values.</td>
</tr>
<tr>
<td>rgba($red, $green, $blue, $alpha)</td>
<td>Creates a Color from red, green, blue, and alpha values.</td>
</tr>
<tr>
<td>red($color)</td>
<td>Gets the red component of a color.</td>
</tr>
<tr>
<td>green($color)</td>
<td>Gets the green component of a color.</td>
</tr>
<tr>
<td>blue($color)</td>
<td>Gets the blue component of a color.</td>
</tr>
<tr>
<td>mix($color1, $color2, [$weight])</td>
<td>Mixes two colors together.</td>
</tr>
</tbody>
</table>
### HSL functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>hsl($hue, $saturation, $lightness)</td>
<td>Creates a Color from hue, saturation, and lightness values.</td>
<td>Yes</td>
</tr>
<tr>
<td>hsla($hue, $saturation, $lightness, $alpha)</td>
<td>Creates a Color from hue, saturation, lightness, and alpha values.</td>
<td>Yes</td>
</tr>
<tr>
<td>hue($color)</td>
<td>Gets the hue component of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>saturation($color)</td>
<td>Gets the saturation component of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>lightness($color)</td>
<td>Gets the lightness component of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>adjust-hue($color, $degrees)</td>
<td>Changes the hue of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>lighten($color, $amount)</td>
<td>Makes a color lighter.</td>
<td>Yes</td>
</tr>
<tr>
<td>darken($color, $amount)</td>
<td>Makes a color darker.</td>
<td>Yes</td>
</tr>
<tr>
<td>saturate($color, $amount)</td>
<td>Makes a color more saturated.</td>
<td>Yes</td>
</tr>
<tr>
<td>desaturate($color, $amount)</td>
<td>Makes a color less saturated.</td>
<td>Yes</td>
</tr>
<tr>
<td>grayscale($color)</td>
<td>Converts a color to grayscale.</td>
<td>Yes</td>
</tr>
<tr>
<td>complement($color)</td>
<td>Returns the complement of a color.</td>
<td>No</td>
</tr>
<tr>
<td>invert($color)</td>
<td>Returns the inverse of a color.</td>
<td>No</td>
</tr>
</tbody>
</table>

### Opacity functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>alpha($color)</td>
<td>Gets the alpha component (opacity) of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>opacity($color)</td>
<td>Gets the alpha component (opacity) of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>rgba($color, $alpha)</td>
<td>Changes the alpha component for a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>opacify($color, $amount)</td>
<td>Makes a color more opaque.</td>
<td>No</td>
</tr>
<tr>
<td>fade-in($color, $amount)</td>
<td>Makes a color more opaque.</td>
<td>No</td>
</tr>
<tr>
<td>transparentize($color, $amount)</td>
<td>Makes a color more transparent.</td>
<td>No</td>
</tr>
<tr>
<td>fade-out($color, $amount)</td>
<td>Makes a color more transparent.</td>
<td>No</td>
</tr>
</tbody>
</table>
### Other color functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>adjust-color()</td>
<td>Increases or decreases one or more components of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>scale-color()</td>
<td>Fluidly scales one or more properties of a color.</td>
<td>Yes</td>
</tr>
<tr>
<td>change-color()</td>
<td>Changes one or more properties of a color.</td>
<td>No</td>
</tr>
<tr>
<td>ie-hex-str()</td>
<td>Converts a color into the format understood by IE filters.</td>
<td>No</td>
</tr>
</tbody>
</table>

### String functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>unquote($string)</td>
<td>Removes quotes from a string.</td>
<td>Yes</td>
</tr>
<tr>
<td>quote($string)</td>
<td>Adds quotes to a string.</td>
<td>Yes</td>
</tr>
<tr>
<td>str-length($string)</td>
<td>Returns the number of characters in a string.</td>
<td>No</td>
</tr>
<tr>
<td>str-insert($string, $insert, $index)</td>
<td>Inserts $insert into $string at $index.</td>
<td>No</td>
</tr>
<tr>
<td>str-index($string, $substring)</td>
<td>Returns the index of the first occurrence of $substring in $string.</td>
<td>No</td>
</tr>
<tr>
<td>str-slice($string, $start-at, [$end-at])</td>
<td>Extracts a substring from $string.</td>
<td>No</td>
</tr>
<tr>
<td>to-upper-case($string)</td>
<td>Converts a string to upper case.</td>
<td>No</td>
</tr>
<tr>
<td>to-lower-case($string)</td>
<td>Converts a string to lower case.</td>
<td>No</td>
</tr>
</tbody>
</table>

### Number functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>percentage($number)</td>
<td>Converts a unitless number to a percentage.</td>
<td>Yes</td>
</tr>
<tr>
<td>round($number)</td>
<td>Rounds a number to the nearest whole number.</td>
<td>Yes</td>
</tr>
<tr>
<td>ceil($number)</td>
<td>Rounds a number up to the next whole number.</td>
<td>Yes</td>
</tr>
<tr>
<td>floor($number)</td>
<td>Rounds a number down to the previous whole number.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### List functions

Lists in SCSS are immutable. All list functions return a new list rather than updating the existing list in-place.

All list functions work for maps as well, treating them as lists of pairs.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>length($list)</td>
<td>Returns the length of a list.</td>
<td></td>
</tr>
<tr>
<td>nth($list, $n)</td>
<td>Returns a specific item in a list.</td>
<td></td>
</tr>
<tr>
<td>set-nth($list, $n, $value)</td>
<td>Replaces the nth item in a list.</td>
<td></td>
</tr>
<tr>
<td>join($list1, $list2)</td>
<td>Joins two lists into one.</td>
<td></td>
</tr>
<tr>
<td>append($list1, $val)</td>
<td>Appends a single value onto the end of a list.</td>
<td></td>
</tr>
<tr>
<td>zip($lists…)</td>
<td>Combines several lists into a single multidimensional list.</td>
<td></td>
</tr>
<tr>
<td>index($list, $value)</td>
<td>Returns the position of a value within a list.</td>
<td></td>
</tr>
<tr>
<td>list-separator($list)</td>
<td>Returns the separator of a list.</td>
<td></td>
</tr>
</tbody>
</table>

### Adding custom functions

```scss
@function my-calculation-function($some-number, $another-number){
  @return $some-number + $another-number
}
```

### SCSS nesting

SCSS lets you nest your CSS selectors in a way that follows the same visual hierarchy of your HTML.

For example:

```css
nav {
  ul {
    margin: 0;
    padding: 0;
    list-style: none;
  }
  li { display: inline-block; }
}
```
The `ul`, `li`, and `a` selectors are nested inside the `nav` selector, which is a great way to organize your CSS and make it more readable. When the widget is rendered, the generated CSS looks something like the following code block:

```
nav ul {
  margin: 0;
  padding: 0;
  list-style: none;
}

nav li {
  display: inline-block;
}

nav a {
  display: block;
  padding: 6px 12px;
  text-decoration: none;
}
```

For more information on Sass, see the Sass/SCSS reference.

**SCSS operators**

SCSS has a handful of standard math operators like `+`, `-`, `*`, `/`, and `%.

Use simple math to calculate widths for an aside & article. For example:

```
.container { width: 100%; }

article[role="main"] {
  float: left;
  width: 600px / 960px * 100%;
}

aside[role="complementary"] {
  float: right;
  width: 300px / 960px * 100%;
}
```

The generated CSS looks like:

```
.container {
  width: 100%;
}

article[role="main"] {
  float: left;
  width: 62.5%;
}

aside[role="complementary"] {
  float: right;
  width: 31.25%;
}
```
SCSS mixins

A mixin lets you make groups of CSS declarations that you want to reuse throughout your site. You can pass in values to make your mixin more flexible.

The following code block is an example for border-radius.

```scss
@mixin border-radius($radius) {
  -webkit-border-radius: $radius;
  -moz-border-radius: $radius;
  -ms-border-radius: $radius;
  border-radius: $radius;
}

.box { @include border-radius(10px); }
```

The generated CSS looks like:

```css
.box {
  -webkit-border-radius: 10px;
  -moz-border-radius: 10px;
  -ms-border-radius: 10px;
  border-radius: 10px;
}
```

Performance Analytics Content Pack for Service Portal

The Performance Analytics Content Pack for Service Portal enables service delivery executives to improve user engagement with your organization’s portals by tracking the usage of portals in preconfigured indicators and data visualizations.

To enable the Performance Analytics Content Pack for Service Portal, install the content pack from the ServiceNow Store. Purchasing a subscription to the licensed Performance Analytics is required to install the content pack.

After you enable the content pack, you can access the Service Portal dashboard by navigating to Performance Analytics > Dashboards. From the dashboard picker, open the Service Portal Usage dashboard.

Assign the pa_viewer role to users who need to view the dashboard. You must have the sp_admin or admin role to edit the dashboard.

The Service Portal Usage dashboard includes the following tabs:

- Overview
- Visitors
- Views
- Searches

You can view reports by selecting options in the interactive filter based on the Service Portal and the Service Portal User Country. The statistics provided in each tab change based on the options selected in the interactive filter.
Overview tab

The Overview tab displays the following widgets:

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Searches</td>
<td>Total number of user searches today.</td>
</tr>
<tr>
<td>Average Click-Through Rate</td>
<td>Average number of searches that have resulted in a click today.</td>
</tr>
<tr>
<td>Average Click Rank</td>
<td>Average position of clicked items in a search result list today. A lower value means a higher position on the search result list.</td>
</tr>
<tr>
<td>Visitors vs Views</td>
<td>Comparison of three metrics:</td>
</tr>
<tr>
<td></td>
<td>Visitors</td>
</tr>
<tr>
<td></td>
<td>Total number of unique visitors per week.</td>
</tr>
<tr>
<td></td>
<td>Pages per Visitor</td>
</tr>
<tr>
<td></td>
<td>Number of unique views by a unique visitor per week.</td>
</tr>
<tr>
<td></td>
<td>Page views</td>
</tr>
<tr>
<td></td>
<td>Total number of unique views per week.</td>
</tr>
<tr>
<td>Top Portals by Page Views</td>
<td>Weekly ranking of portals by the number of unique views.</td>
</tr>
<tr>
<td></td>
<td>Name</td>
</tr>
<tr>
<td></td>
<td>Name of the portal.</td>
</tr>
<tr>
<td></td>
<td>Week</td>
</tr>
<tr>
<td></td>
<td>Number of unique views each week.</td>
</tr>
<tr>
<td></td>
<td>Change %</td>
</tr>
<tr>
<td></td>
<td>Percentage of change in the number of unique views since last week.</td>
</tr>
<tr>
<td></td>
<td>Trend</td>
</tr>
<tr>
<td></td>
<td>Visualization of how the number of unique views has changed over the course of the last month.</td>
</tr>
<tr>
<td></td>
<td>Distribution</td>
</tr>
<tr>
<td></td>
<td>Visualization of the number of unique views in relation to other portals in your instance. A full bar means that the portal has the highest number of unique views.</td>
</tr>
</tbody>
</table>
Visitors tab

The Visitors tab displays the following widgets:

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visitors - Last 7 Days</td>
<td>Total number of unique visitors in the last week.</td>
</tr>
<tr>
<td>Visitors</td>
<td>Number of unique visitors each day, over the course of the last week.</td>
</tr>
<tr>
<td>Top Pages by Unique Visitor</td>
<td>Daily ranking of pages by number of unique visitors.</td>
</tr>
<tr>
<td></td>
<td><strong>Name</strong></td>
</tr>
<tr>
<td></td>
<td>Name of the page.</td>
</tr>
<tr>
<td></td>
<td><strong>Day</strong></td>
</tr>
<tr>
<td></td>
<td>Number of unique visitors each day.</td>
</tr>
<tr>
<td></td>
<td><strong>Change %</strong></td>
</tr>
<tr>
<td></td>
<td>Percentage of change in number of unique visitors since yesterday.</td>
</tr>
<tr>
<td></td>
<td><strong>Trend</strong></td>
</tr>
<tr>
<td></td>
<td>Visualization of how the number of unique visitors has changed over the</td>
</tr>
<tr>
<td></td>
<td>course of the last week.</td>
</tr>
<tr>
<td></td>
<td><strong>Distribution</strong></td>
</tr>
<tr>
<td></td>
<td>Visualization of the number of unique visitors in relation to other</td>
</tr>
<tr>
<td></td>
<td>pages. A full bar means that the page has the highest number of unique</td>
</tr>
<tr>
<td></td>
<td>visitors.</td>
</tr>
</tbody>
</table>
### Visitors - Last 7 Days

195

- 2 (-2.0%)

![Graph showing visitors over the last 7 days](image)

**Top Pages by Unique Visitor**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>public_survey</td>
<td>6</td>
<td>7</td>
<td>2</td>
<td>9</td>
<td>13</td>
<td>9</td>
<td>-16.7%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>requests</td>
<td>5</td>
<td>1</td>
<td>3</td>
<td>6</td>
<td>4</td>
<td>3</td>
<td>8</td>
<td>166.7%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>kb_article_view</td>
<td>8</td>
<td>4</td>
<td>3</td>
<td>9</td>
<td>7</td>
<td>3</td>
<td>7</td>
<td>133.3%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>kb_search</td>
<td>10</td>
<td>3</td>
<td>4</td>
<td>4</td>
<td>3</td>
<td>6</td>
<td>7</td>
<td>16.7%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sc_category</td>
<td>7</td>
<td>8</td>
<td>4</td>
<td>4</td>
<td>6</td>
<td>7</td>
<td>3</td>
<td>57.1%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Views tab**

The Views tab displays the following widgets:

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Views - Last 7 Days</td>
<td>Total number of portal views in the last week.</td>
</tr>
<tr>
<td>Views</td>
<td>Number of portal views each day, over the course of the last week.</td>
</tr>
<tr>
<td>Top Pages by Views</td>
<td>Daily ranking of pages by the number of unique views.</td>
</tr>
<tr>
<td></td>
<td><strong>Name</strong></td>
</tr>
<tr>
<td></td>
<td>Name of the page.</td>
</tr>
<tr>
<td></td>
<td><strong>Day</strong></td>
</tr>
<tr>
<td></td>
<td>Number of unique views each day.</td>
</tr>
<tr>
<td></td>
<td><strong>Change %</strong></td>
</tr>
<tr>
<td></td>
<td>Percentage of change in number of unique views since yesterday.</td>
</tr>
<tr>
<td></td>
<td><strong>Trend</strong></td>
</tr>
<tr>
<td></td>
<td>Visualization of how the number of unique views has changed over the course of the last week.</td>
</tr>
<tr>
<td></td>
<td><strong>Distribution</strong></td>
</tr>
<tr>
<td></td>
<td>Visualization of the number of unique views in relation to other pages. A full bar means that the page has the highest number of unique views.</td>
</tr>
</tbody>
</table>
### Top Pages by Views

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>public survey</td>
<td>56</td>
<td>52</td>
<td>21</td>
<td>24</td>
<td>21</td>
<td>21</td>
<td>29</td>
<td>-3.2%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>kb article view</td>
<td>32</td>
<td>26</td>
<td>17</td>
<td>19</td>
<td>23</td>
<td>24</td>
<td>23</td>
<td>-32.4%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>kb search</td>
<td>31</td>
<td>25</td>
<td>16</td>
<td>16</td>
<td>12</td>
<td>20</td>
<td>21</td>
<td>-12.5%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>requests</td>
<td>11</td>
<td>21</td>
<td>13</td>
<td>18</td>
<td>17</td>
<td>21</td>
<td>20</td>
<td>-4.8%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sc category</td>
<td>21</td>
<td>32</td>
<td>12</td>
<td>12</td>
<td>18</td>
<td>21</td>
<td>15</td>
<td>-28.6%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Views**

- **822** views in the last 7 days.
- **15 (1.9%)** increase from the previous period.

**Graph**

- Shows views from 24 Oct to 31 Oct.
- X-axis represents dates.
- Y-axis represents view counts.
- Trend indicates upward or downward trend in views.

**Visualization Options**

- Scorecard
- Breakdown
- Service Portal Page
Searches tab

The Searches tab displays the following widgets:

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Click Rank</td>
<td>Average position of clicked items in a search result list today. A lower value means a higher position on the search result list.</td>
</tr>
<tr>
<td>Average Click-Through Rate</td>
<td>Average number of searches that have resulted in a click today.</td>
</tr>
<tr>
<td>User who Searched</td>
<td>Number of users who searched the portal today.</td>
</tr>
<tr>
<td>Click Rank Distribution</td>
<td>Number of clicks within each click rank today.</td>
</tr>
<tr>
<td>Searches</td>
<td>Total number of user searches today.</td>
</tr>
</tbody>
</table>
Breakdowns

To analyze data according to different categories, select a breakdown from the dashboard menu:

- Service Portal
- Service Portal Page
- Service Portal User Country
Skills Management

Use Skills Management to associate skills with individual users or groups and assign them to tasks or projects. You can also assess the skills needed for your organization, identify gaps, and implement effective plans for hiring or training of your teams.

Skills can contain other skills. For example, if you define network as a skill, you can add router as the skill it contains. A user assigned to a parent skill grants access to a child skill. Once a skill is assigned to a group, all members of the group inherit that skill and any others contained within it. Skills management works similar to ServiceNow platform role management.

Using this application, you can:

• Manage skills for agents and your employees from a central location.
• Use a standard way to identify skills for your organization and keep them up to date.
• Group skills into categories and define skill levels to track the expertise of your resources at a granular level.
• Prevent task or project reassignments by assigning tasks to agents and projects to teams that have the right skills to work on those items.
• Identify skill gaps and resolve them by implementing effective plans for coaching and training of resources.
• Manage the effectiveness of your team by evaluating the skills your team has and determining what skills you need to work on your projects.

For more information on analyzing data with breakdowns, see Using breakdowns on dashboards.
Integration with ServiceNow® applications

A skill is an ability to do something that comes from training, experience, and practice. As a system administrator, you can define skills for your organization and assign it to users and groups from a central location. As an application manager, you can assign users to tasks based on these skills. For example, if you are an IT manager, you can use the Skills Management application to define skills for your agents and assign those agents to resolve incidents using the ITSM application.

Group skills into categories and define skill levels to standardize skill implementation across your organization.

Use skills from the centralized location in the following applications:

- **IT service management**
  
  As an IT manager, reduce time and cost while resolving incidents by assigning work items to the right agent. Assess skill gaps agents have in your team and coach or train agents based on the needs. Identify and define a standard way to keep skill categories and levels consistent within your team.

- **Customer service management**
  
  As a customer service manager, identify agent skills and automatically route tasks to agents who have the required skill to work on those tasks. Manage your team’s effectiveness by understanding what type of skills your employees have in dynamic situations where employees are hired, leave, or get trained to take on other roles.

- **Field service management**
  
  As a field service or customer service manager, use rules to identify skills and skill levels that agents require to resolve work items such as cases, work order tasks, and agent interactions. Automate skill assignment to reduce manager work load. Automatically assign tasks to agents using Field Service dynamic scheduling.

- **Human resources management**
  
  As an HR manager, use skills to identify the type of skills your organization needs and make hiring decisions based on those needs. Manage your team’s effectiveness by understanding what type of skills your employees have in dynamic situations where employees are hired, leave, or get trained to take on other roles.

- **Project portfolio management**
  
  As a project and portfolio manager, standardize how you categorize skills, define skill level types, and add skill levels for your team. Set up skills for your team in a central location and make them available within your team. Prevent project reassignments by assigning the right projects to the team members who have the right skills to work on those projects.

### Roles used in Skills Management

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
</table>
| Skill administrator [skill_admin] | • Inherits the skill manager [skill_manager] and skill user [skill_user] roles.  
  • Can perform create, read, update, and delete (CRUD) operations on skills, skill levels, skill level types, skill categories, and sub categories. |
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
</table>
| Skill manager [skill_manager] | - Inherits the skill user [skill_user] role.  
- Can perform read operations on skills, skill levels, skill level types, skill categories, and sub categories.  
- Can assign skills to users and groups. |
| Skill user [skill_user]     | Can perform read operations on skills, skill levels, skill level types, skill categories, and sub categories.                               |

**Activating Skills Management**

The Skills Management application is activated when you enable the Skills Management (com.snc.skills_management) plugin.

**Configuring skills**

Create skills, identify the type of skill level it belongs to and associate skill levels for each type to define skills for your users consistently across your organization. For example, you can add French as a skill, language as the skill level type, and familiar, proficient, and expert as the skill levels.

Identify all skills you currently have and would need across your organization to begin implementing skills. For example, if you are using Customer Service, you may have agents who have Java as a technical skill and you may need agents who have experience in network administration. If you are using Human Resources, you may have employees who have coaching as a skill and you may need employees who can get new hires on board.

Associate each skill you have identified with a skill level type. For example, you can associate Java with programming as the skill level type and coaching with leadership as the skill level type.

Define skill levels for each type you have identified. As an example, you can use familiar, proficient, and expert as skill levels for the Java skill level type and beginner, intermediate, and advanced as the skill levels for the coaching skill level type.

**Define skill taxonomy**

Organize related skills into categories and subcategories so that you can manage skills and create reports quickly and efficiently.

Role required: skill_admin

A skill category can contain parent and child categories that together create a category hierarchy. You can add skills to the lowest category in the hierarchy.

You can build your skill taxonomy from scratch or use the sample data provided with your application.
Navigate to Skills > Skill Taxonomy.

**Name**: Financial Management

**Description**: Financial Management skills include planning, organizing, directing and controlling the financial activities such as procurement and utilization of funds of the enterprise.

**Parent**: Financial Management

**View hierarchy**: Parent view | Full view

- **Financial Management** - (Current Skill)
  - **Collection & Payments**
  - **Accounting**
  - **Budget & Finance**
2. In the **Skills Categories** list, click **New**.
3. In the **Name** field, enter a unique name for the category.
4. Optional: In the **Parent** field, select a parent category.
5. Right-click the form header and click **Save**.
   The category is added to the **Category Hierarchy**.
6. Do one of the following:

<table>
<thead>
<tr>
<th>To add</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Subcategories</strong></td>
<td>• In the <strong>Child Categories</strong> related list, click <strong>New</strong>.</td>
</tr>
<tr>
<td></td>
<td>• In the <strong>Name</strong> field, enter a unique name for the category.</td>
</tr>
</tbody>
</table>

| **Skills** | • Enable the **Add Skills** check box.                                      |
|           | • Right-click the form header and click **Save**.                             |
|           | • In the **Skills** related list, click **New**.                             |
|           | • In the **Name** field, enter the name of the skill.                        |

7. Click **Submit**.

**Create skill categories using sample data**

Onboard your team quickly using the skill taxonomy framework provided with your application.

Role required: skill_admin

The sample data provides 150 records that you can use to get started with to build your skill taxonomy.

1. **Activate** the Skills Library Data for Skills Management (com.snc.skills_management.seed_data) plugin.
2. Navigate to **Skills** > **Skill Taxonomy**.
3. In the **Skill Categories** list, review each category and set the **Add skills** field to true for all skill categories you want to add to your application.

**Define a skill level type**

Define skill levels (for example, beginner, intermediate, advanced) for different skill level types (for example, a language or an IT certification) and then associate skill levels to users and define skill levels and types required for tasks.

Role required: skill_admin or admin

1. Identify skill level types.
   
   You can group skills that belong to the same category into a skill level type. For example, you could use language as the skill level type if Japanese and French are defined as skills. Take an inventory of every type of skill your organization needs.

2. Add skill level types, define skill levels, and associate them with a skill level type.
   
   After you add a skill level type, you can define different levels for that type of skill. For example, if you add language as a type of skill, you can associate familiar, proficient, and expert as skill levels. When you select French, for example, as a skill for a user, you will be able to define the user's skill level for French as either familiar, proficient, or expert.

   a) Navigate to **Skills** > **Skill Level Types**.

   b) Click **New**.

   c) Enter a name and description for the skill level type and then right-click the form and click **Save**.

   d) To associate skill levels with this skill type, add a name and value for the skill level.
The value is used to measure skill gaps. For example, if you give a value of 10 for a skill level defined as proficient and a value of 25 for a skill level defined as expert, when you create a skill report to measure gaps, you will see a value of 15 as a measure for the skill gap.

3. Click **Submit**.

The example below shows a system administrator creating the skill level type Language, adding the skill level Proficient to that type and associating a value for the level.
Make your life easier, create a dashboard!

Did you know you can create a dashboard version of this homepage? Dashboards are like homepages, but easier to use. Dashboards have a drag-and-drop canvas that lets you easily add, move, and resize widgets. You can also add multiple tabs. Wizard sharing is any user view and collaborate on dashboards with your team.

System Administration

- Guided Setup: Guided setup tools to help you set up ServiceNow
- System Security: Configure and monitor instance security settings
- Business Logic: Manage architecture and behavior of applications
- Create and Deploy: Create, modify, and deploy applications to your instances
- Data Management: Manages data store, content, and displayed
- Diagnostics: Performance, development, and data gathering tools
- Email: Email behavior of inbound and outbound email
- Homepages: Configure messages for service desk and field service users
- Integration: Integrates with third-party systems and data sources
- Reporting and Analytics: Create visual representations of your data
- User Administration: Manage user groups and their roles
- User Interface: Customize look and feel of applications

Create dashboard service
Add a skill

Create skills to specify the competencies of your users and associate them with sub skills, users, and configuration items.

Role required: skill_admin or admin

1. **Identify skills.**
   
   Take an inventory of all skills you currently have and would need across your organization. For example, if you are using Customer Service, you may have agents who have Java as a technical skill and you may need agents who have experience in network administration. If you are using Human Resources, you may have employees who have coaching as a skill and you may need employees who can get new hires on board.

2. **Add skills.**
   
   You can associate each skill with other skills, users, or configuration items. You can assign users to tasks or projects, or identify employees with specific skills using these associations.

   a) Navigate to **Skills > All Skills.**
   
   b) Click **New.**
   
   c) Enter a name and description for the skill and then right-click the form and click **Save.**
   
   d) To associate sub skills to the skill, click the **Contains Skills** tab and create a new skill or add an existing skill.
      
      The sub skill is automatically inherited by the user or group that contains the associated skill.
   
   e) To specify skills for users, click the **Users** tab and create a new user for the skill or add existing users.
   
   f) To associate the skill with configuration items, click the **Model** tab and add one or more configuration items.

3. **Click Update.**

Managing skills

Manage skill assignment efficiently by simultaneously assigning a skill to multiple users or multiple skills to multiple users. Assign your agents to tasks and teams to projects based on skills.

Assign IT skills to users

Assign IT skills and skill levels to users to facilitate the automatic assignment of skill-based tasks to agents.

Role required: skill_manager or skill_admin

Only skill administrators can create or edit skills. Skill managers can assign skills to users.

1. **Navigate to** **Skills > Manage IT Skills.**

2. Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a skill to a user</td>
<td>a. Click <strong>New Skill.</strong></td>
</tr>
<tr>
<td></td>
<td>b. In the <strong>Skill</strong> field, enter a name for the skill.</td>
</tr>
<tr>
<td></td>
<td>c. In the <strong>Level Type</strong> field, select the type to which the skill belongs.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>----</td>
<td>---------</td>
</tr>
</tbody>
</table>
| Assign a skill to multiple users | a. From the All Skills list, select a skill.  
   b. Click Assign/Remove Users.  
   c. Select the name of each user you want to assign this skill.  
   d. From the list, select the level for this skill for each user.  
   e. Click Assign/Remove Users again to assign the skill and skill level to the users. |

To remove the assigned skill, select the name of the user and clear the check box for the skill.

| Assign multiple skills to multiple users | a. From the All Users list, select a user.  
   b. From the Skill list, select each skill and the skill level to assign for this user.  
   c. Repeat the steps above for all users you would like assign multiple skills and associated skill levels. |
In this example, a system administrator assigns the skill **iPhone** to multiple users and adds a skill level for each user.
In this example, a system administrator assigns multiple skills and associated skill levels to multiple users.
ServiceNow    DocVersion    Now Platform  capabilities

Associate skills with users and groups
Add skills to users and groups and effectively assign users to tasks and teams to projects.
Role required: skill_manager
Users automatically inherit a skill contained within a skill. Members of a group inherit all skills assigned to the group.

1. Perform one of the following actions:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign a skill to a user</td>
<td>a. Navigate to Skills &gt; User Skills.</td>
</tr>
<tr>
<td></td>
<td>b. Click New.</td>
</tr>
<tr>
<td></td>
<td>c. In the Skill field, click the lookup icon and select a skill.</td>
</tr>
<tr>
<td></td>
<td>d. In the User field, click the lookup icon and select a user.</td>
</tr>
</tbody>
</table>

Assign a skill to a group

b. Click New.

c. In the Skill field, click the lookup icon and select a skill.

d. In the Group field, click the lookup icon and select a group.

2. Optional: In the Skill level field, click the lookup icon and select a level for the selected skill.

3. Optional: If the skill level is inherited, enable the Skill level inherited check box.
   You must configure the form to display the Skill level field and Skill level inherited check box.

4. Click Submit.

Associating skills with work items
Assign skills to tasks manually or use rules to associate them automatically to work items such as cases, tasks, or chat interactions.

Assign skills to tasks
Add skills and the level required for each skill to tasks. Identify whether the skill is mandatory to perform the task.
Role required: admin

1. Navigate to incident, problem, change request or any task record to which you want to associate skills.

2. In the related list, select the Tasks Skills tab.
   You must configure the related list and add Task Skill->Task to the Selected column to display this tab.

3. In the Task Skills table, do the following:
   a. In the Skill field, click the lookup icon and select a skill.
   b. In the Skill level field, select a level for the selected skill.
   c. In the Mandatory field, select true if the skill is mandatory for the selected task.

4. Click Submit.
The image below shows an administrator configuring skills for an incident task where the user is unable to access the shared folder. It is mandatory for agents working on this task to have familiarity with IT skills.
Using rules to identify skills for work items

Automate the identification of skills required for work items using rules, which eliminates the need to assign them manually.

When you automate skill identification, you prevent task reassignments by assigning agents with the right skills to work on tasks and make time available for agents and managers to work on more important tasks.

You can identify skills using rules for tasks such as cases, work order tasks, incidents, problems, and change requests and also for interactions such as chat, phone, or walk-up experience.

Create rules to assign skills to work items

Create rules to identify skills and automatically associate them to work items.

Role required: skill_admin or admin

You can automatically add a skill to a case based on the product associated with the case if you enable the Product to Skill mapping table (Skill Required for Model Maintenance [cmn_m2m_skill_model]).

A skill determination rule is created for every new skill required for a work item.

- If a skill is no longer required for a work item, you must deactivate or remove the rule applied for the work item.
- If two rules have the same skill associated with one work item and one rule evaluates the skill as mandatory and the other rule evaluates it as optional, then the rule that evaluates the skill as mandatory is always used.

Note: If you create a new skill determination rule, you also need to create a corresponding business rule.

1. Navigate to Skills > Skill Determination Rules.
2. Click New.
3. In the Name field, enter a name for the rule.
4. Select the Active check box to enable the rule to assign skills to work items.
5. From the Source table drop-down menu, select the work item source table for this rule.
6. Using the condition builder, select the conditions to evaluate the work item.
7. Do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a simple rule</td>
<td>a. From the Type drop-down menu, select Simple.</td>
</tr>
<tr>
<td></td>
<td>b. In the Skills table, add each skill that is required for the selected work item.</td>
</tr>
<tr>
<td></td>
<td>c. If a skill is optional for selected work item, in the Mandatory field, select False.</td>
</tr>
<tr>
<td></td>
<td>d. In the Skill Level field, add a level for the skill. You must configure the form to display this field.</td>
</tr>
</tbody>
</table>

Note: You can define skill levels using the Skills Management application.
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Create a lookup rule | a. From the **Type** drop down menu, select **Lookup**.  
  b. From the **Lookup table** drop-down menu, select the reference table to connect to the source table.  
  The **Skills Field** that connects the source and reference tables is automatically populated.  
  c. If this skill is mandatory, enable the **Mandatory** check box.  
  d. From the **Skill Level Field** drop-down menu, select a level for this skill.  
  e. Click **Save**.  
  f. In the **Field Mappings** related list, click **New**.  
  g. From the **Source table field** drop-down menu, select an attribute to map to the reference table.  
  h. From the Lookup table field drop-down menu, select an attribute to map to the source table. |
| Create an advanced rule | a. From the **Type** drop down menu, select **Advanced**.  
  b. In the **Script** window, enter a script. |

8. **Click Submit.**

**Activate business rules for skill determination**

Enable the business rules to determine skills for cases, work order tasks, and chat interactions that are available in your application.

Role required: admin

You can also **Create a business rule** for tasks such as incidents, problems and change requests to associate skills to those tasks.

Create skill determination rules based on any of the following rule types:

- **Simple**
  Adds skills to work items based on a set of conditions used to evaluate the source table.
- **Lookup**
  Adds skills to work items based on selections from two different tables connected using one or more reference fields.
- **Advanced**
  Adds skills to work items using a script.

2. Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Enable the business rules for cases, work order tasks, or chat interactions | • To create rules for cases, select the **Active** check box in the **Skill determination for case** business rule record.  
• To create business rules for work order tasks, select the **Active** check box in the **Skill determination for work order task** business rule record.  
• To create rules for chat interactions, select the **Active** check box in the **Skill determination for interaction** business rule record. |

Create business rules for tasks such as incidents, problems, and change requests

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>Open a case, work order, or chat interaction business rule record.</td>
</tr>
<tr>
<td>b.</td>
<td>Right-click the record and select <strong>Insert and Stay</strong>.</td>
</tr>
<tr>
<td>c.</td>
<td>In the <strong>Name</strong> field, enter a name for the business rule.</td>
</tr>
<tr>
<td>d.</td>
<td>In the <strong>Table</strong> field, select the task table.</td>
</tr>
<tr>
<td>e.</td>
<td>Click <strong>Update</strong>.</td>
</tr>
</tbody>
</table>

Routing work items to agents based on skills

Use rules to automatically route work items to agents.

For more information on routing agents to work items, see Advanced work assignments

Qualify and rank users based on skills and skill levels

Rank users so that you can select the right users based on skills needed to complete tasks. Qualify users to work on tasks such as case, work order task, or chat interaction based on the number of skills and skill levels required to work on those tasks.

Role required: skill_admin

Use the **UserSkillAnalyzer API** to analyze the skills and skill levels of users and the **UserSkillRanking API** to rank and assign them to tasks. For example, when you use the Field Service Management application to assign agents to tasks, you can analyze and rank them based on their skills and skill levels using these APIs and use dynamic scheduling to assign them to tasks.
1. Analyze the skills and skill levels users have to complete work items using the UserSkillAnalyzer API. The API performs the following verification to check if users are qualified to be assigned to the work items:
   a. If the user has all mandatory skills required to complete the work item, but does not have the skill level, the agent is not qualified to work on the task if the skill level is mandatory to work on the task.
   b. If the user does not have all mandatory skills required to complete the task, the agent is not qualified to work on the task.
   c. If the user has all skills and the skill levels required to complete the task, the agent is qualified to work on the task.
   d. If the user has all skills required, but not mandatory to complete the task, the agent is qualified to work on the task.

   If the user is qualified to work on the task, the API performs the following verification to analyze gaps in skill level and the total number of skills the users have to execute tasks based on the skill requirements for the work item:
   a. Verifies if a work item requires a skill that does not have a level type defined.
   b. Verifies if a work item requires a skill that has a level type defined but does not have the skill level defined.
   c. Verifies if a work item requires a skill that has the skill level defined, but the agent does not have the skill level defined. If the skill level is mandatory to complete the task, the user who does not have those skill levels will not be assigned to those tasks.
   d. Verifies whether a user has all skill levels that are mandatory, but not optional, to perform a task.

2. Rank users qualified to complete work items using UserSkillRanking API. The API retrieves a list of qualified users based on matching and mandatory skills and skill levels.

Skills Management dashboard and reporting

Use the Skills Management dashboard to analyze trends in assessing skill gaps in your organization and plan for coaching or training of your employees based on needs. Identify users and teams who have the right skills to work on tasks and projects. The Skills Management dashboard provides comprehensive reports on skill competencies of users, the tasks that require those skills, and skill gaps you can address to fulfill your organizational needs.

You can access the dashboard by navigating to Skills > Dashboard.
You can filter these reports based on the skill category and view reports for each category.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>As a skill manager, you can:</td>
<td>skill_manager</td>
</tr>
<tr>
<td>• Build your teams based on the skills set your organization needs.</td>
<td></td>
</tr>
<tr>
<td>• Have visibility into skill competencies of employees.</td>
<td></td>
</tr>
<tr>
<td>• Analyze skill gaps and plan for coaching or training of your employees based on the needs.</td>
<td></td>
</tr>
<tr>
<td>• Identify users who have a specific skill or belong to specific skill categories.</td>
<td></td>
</tr>
<tr>
<td>• Track skill proficiencies of users over time.</td>
<td></td>
</tr>
<tr>
<td>• Identify key skills being used in solving your business needs and the users with those skills.</td>
<td></td>
</tr>
<tr>
<td>• Build learning programs based on skill strengths, weaknesses, preferences, gaps, and risks identified for your organization.</td>
<td></td>
</tr>
<tr>
<td>• Build teams based on skills you need to complete projects.</td>
<td></td>
</tr>
<tr>
<td>• Evaluate how effectively users solve business needs using their skill competencies and provide feedback to implement improvements.</td>
<td></td>
</tr>
<tr>
<td>• Review how efficiently work assignments are made based on skill levels.</td>
<td></td>
</tr>
<tr>
<td>• Match user skills with skills needed to complete work items and assign projects to teams based on those skills.</td>
<td></td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Skills Matrix | Multi-level pivot table | • View competencies for all users in a particular group.  
• View the competency of all users for a particular skill in a group. |
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top 10 skills used in the last six months</td>
<td>Bar chart</td>
<td>Identify the top 10 skills that are in use and which users have those skills.</td>
</tr>
<tr>
<td>Tasks associated with skills</td>
<td>Bar chart</td>
<td>View the number of tasks that have skills assigned to them. The example report shows data for the last six months.</td>
</tr>
<tr>
<td>Users with Skills</td>
<td>Bar chart</td>
<td>View the total number of users with skills assigned in each skill category.</td>
</tr>
<tr>
<td>Skills in Category</td>
<td>Bar chart</td>
<td>View the total number of skills in the selected category.</td>
</tr>
<tr>
<td>List of user skills</td>
<td>List of skills</td>
<td>View number of users available for each skill.</td>
</tr>
</tbody>
</table>

**Domain separation and skills management**

Domain separation in Skill Management app is configured to apply to all features of the application. Separation of data is configured along with separation of logic and process. Domain separation enables...
you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Support: Level 1

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation. The Skills Management application enables you to track and organize skill data of service agents and employees in a domain separated environment. The skill data can be used for skill-based task assignment, skill gap analysis to identify coaching and training needs, career growth planning, workforce optimization and skill-based hiring. All skill related tables support domain separation so that the people with skill user, skill manager and skill admin roles can view only the skill and related tasks within the (tenant) domain to which they belong.

How domain separation works in Skills Management

Domain separation is supported in Skill Management with no explicit setup or configuration requirements. Skills, skill categories, skills levels can be created in separate domains, including the global domain. When domain separation is implemented, people with skill app roles can view skill information only in the domain assigned. Domain and Domain Path columns are available for all Skill tables provided with the base system. The Domain column contains the name of the domain to which the event or alert belongs, and the Domain Path column contains the unique domain identifier.

<table>
<thead>
<tr>
<th>Table name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_user_has_skill</td>
<td>User skill information</td>
</tr>
<tr>
<td>cmn_skill</td>
<td>Main skill table</td>
</tr>
<tr>
<td>cmn_skill_category</td>
<td>Define skill categories</td>
</tr>
<tr>
<td>cmn_skill_level_type</td>
<td>Define skill level type</td>
</tr>
<tr>
<td>cmn_skill_level</td>
<td>Define skill level</td>
</tr>
<tr>
<td>sys_group_has_skill</td>
<td>Group skills</td>
</tr>
<tr>
<td>cmn_skill_contains</td>
<td>Define skills contained within skills</td>
</tr>
<tr>
<td>task_m2m_skill</td>
<td>Task skill information</td>
</tr>
</tbody>
</table>

Note: If the domain column is not shown, click the Update Personalized List icon and add the required column. You can also add the domain path column, if desired.

Use cases:

• A Skill Manager that belongs to the Acme domain creates a skill and wants to view and associate it to user in the Acme domain. A user must belong to the Acme domain, its parent domain, or the global domain to view the skill record.
• A Skill Manager that belongs to a parent domain tries to view a skill in a child domain. The user of a parent domain can view a skill record of the parent as well as all child domains of that parent.
• A Skill Manager that belongs to a parent domain wants to create/associate a skill on behalf of another user in the Acme domain. A user must belong to the same domain as the user for which the skill record is created.
Quick start tests for Skills Management

Validate that Skills Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Skills Management quick start tests require activating the Skills Management plugin (com.snc.skills_management).

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skills MGMT: User skill level inheritance when user is part of multiple groups</td>
<td>Verify that the user is assigned the highest skill level when the user belongs to multiple groups that have been assigned the same skills with different skill levels.</td>
</tr>
<tr>
<td>Skills MGMT: Add skills to lowest level category</td>
<td>Verify that skills can be added to the lowest level category.</td>
</tr>
<tr>
<td>Skills MGMT: Create a child category under a parent category</td>
<td>Verify that a lower-level category can be created when the flag for Add skills is unchecked in the parent category.</td>
</tr>
<tr>
<td>Skills MGMT: Create a skill category</td>
<td>Verify that a skill category can be created on the skill category form.</td>
</tr>
<tr>
<td>Skills MGMT: Create skill level type and skill levels</td>
<td>Define the skill level type and different skill levels for the type.</td>
</tr>
<tr>
<td>Skill MGMT: Skill level inheritance from group to user</td>
<td>Verify that skill levels can be inherited from a group to the users of the group and that the Inherited and Skill level inherited fields are set to true.</td>
</tr>
</tbody>
</table>

Subscription Management

With the ServiceNow® Subscription Management application, review and manage how your ServiceNow subscriptions are used on your production instance. Subscriptions are downloaded to production instances only and not to development or QA instances.

Explore
- Upgrade to New York
- Domain separation in Subscription Management

Set up
- Video: Getting Started with Subscription Management
- Subscription Management setup
- Configure the color codes for subscription allocation levels

Administer
- Subscription Management administration
- Allocating users to a Per-User subscription
- Allocating custom tables to subscription entitlements
- View your subscription applications and allocation levels
Use

- Allocating users to a Per-User subscription
- Allocating your custom tables to subscription entitlements
- Build a subscription user set
- Add a user set to a subscription
- Allocate an individual user from the Subscription form
- Unsubscribe a user

Troubleshoot and get help

- Ask or answer questions in the Subscription forum
- Search the HI Knowledge Base for known error articles
- Contact ServiceNow Technical Support

Subscription Management setup

Because Subscription Management is active for all production instances by default, you do not need to activate a plugin. To set up Subscription Management, you assign the usage_admin role to the users who administer subscriptions. The admins allocate users to appropriate subscriptions, monitor usage of applications (both by subscribed users and by users who are not subscribed), and update subscription levels as needed.

What to do

Assign the Usage Admins

Before you (the admin user) do anything else, assign the usage_admin role to the persons who will manage subscriptions for your organization.

Admin responsibilities and activities are described in Allocating users to a Per-User subscription, Allocating your custom tables to a subscription entitlement and Monitoring how your resources are allocated for subscriptions.

View the list of your subscription applications

See View your subscription applications and allocation levels.

If your organization purchased Per-User subscriptions, the usage_admin allocates users

Note: You perform this task only for Per-User subscriptions. Your instance auto-allocates and reports on monthly usage for all other subscription types.

With a Per-User subscription, a specified number of users is entitled to use the application. You perform the following tasks:

- Build user sets.
- Allocate users to appropriate subscriptions.
- Monitor whether you have allocated the right number of users.
- Monitor and manage how users are allocated.

See Allocating users to a Per-User subscription.
If your organization purchased subscriptions that include a custom table entitlement, the usage_admin allocates custom tables to subscriptions

Some ServiceNow subscriptions include custom table entitlements to enable and track configurations and customizations. For these subscriptions, you perform the following tasks:

- Allocate custom tables to subscription entitlements. For example, a single subscription might include a total entitlement of 50 custom tables. You can create custom tables for any purpose, up to the entitlement limit in the subscription.
- Monitor and manage how custom tables are allocated to specific subscription entitlements.

See Allocating your custom tables to a subscription entitlement.

What to do next

Day-to-day administration: Monitor and manage subscriptions

See Monitoring how your resources are allocated for subscriptions

Domain separation in Subscription Management

This is an overview of domain separation in Subscription Management. Domain separation is not supported in this application. For more information, see Application support for domain separation.

Overview

Domain separation is not supported in this application. For more information, see Application support for domain separation.

Configure the color codes for subscription allocation levels

On lists, forms, and charts, a configurable color code indicates the percentage of the subscription that has been allocated. This applies to both user and custom table allocations.

Role required: usage_admin or admin

In the example, the green color code that appears in the Allocated column for Financial Management, and the yellow code for the ITSA Fulfiller application, indicate that you can allocate additional users. The red code for Facilities Service Automation indicates that you have allocated more users (or custom tables) than you have purchased a subscription for.

Note: If the subscription contains a custom table entitlement, this color coding scheme also appears in a Tables used column in the Subscriptions list. To learn more about custom table allocations, see Allocating your custom tables to a subscription entitlement and Allocate your custom tables to subscriptions.
1. Navigate to **Subscription Management > Properties.**

2. Update the **Threshold for color codes** [subscription.used.thresh] property setting and then click **Save.**

   Specify a percentage value greater than 0 and less than 100. Default: 90% of the purchased subscription limit.

   - Subscription allocation levels below the specified threshold are marked with a green color code.
   - Allocation levels between the threshold and 100% are marked yellow.
   - Allocation levels above 100% are marked red.

**Subscription Management administration**

You use the ServiceNow® Subscription Management application to review and manage how purchased subscriptions are used on your production instance. You can monitor usage of subscription applications to update subscription levels and to make informed decisions about subscription purchases.

**What is a subscription?**

In contrast to companies that sell software licenses, ServiceNow sells subscription services.

- Your organization has purchased a **subscription** to an application family. The subscription entitles an agreed-upon number of users or resources in your organization to use the applications.
- For Per-User type subscriptions only, you **allocate** users to the subscription. As a result, the user is **subscribed** to the family of applications. For other subscription types, the instance auto-allocates users or resources to the subscription.
• For your organization to comply with its service contract, only subscribed users or resources should use a subscription application family.
• The Subscription Management application monitors your purchased subscriptions on production instances only.

How do you use Subscription Management?

The usage_admin can perform the following tasks:
• Receive and view subscriptions that your organization has purchased.
• Monitor and adjust allocation levels.
• Plan for renewing subscriptions.
• Determine which users (by role, by user group, or by some other criterion) should be subscribed to which Per-User subscription applications.
• Build user sets.
• Manage user sets as users, roles, and groups change over time.
• Allocate users and user sets to each of the Per-User subscriptions.
• Allocate custom tables created in the instance to subscriptions with custom table entitlements.
• Monitor App Engine subscription usage and compliance

View your subscription applications and allocation levels

The Subscriptions page lists the subscriptions that your organization has purchased and indicates how many users or resources are allocated to each subscription.

Role required: usage_admin or admin
The page lists only subscriptions that are currently active (have not expired). To view expired subscriptions as well, set the list filter to **All**.

1. **On your production ServiceNow instance, navigate to Subscription Management > Subscriptions.**
   - The page attempts to list all subscriptions that your organization has purchased. Some subscriptions do not appear. See **Why a subscription might not appear in the list**.
   - A color code indicates the allocation level (the number of resources that are subscribed to the application).
   - Headings on the **Subscriptions list** are described in **Subscription form**.

2. **Click a subscription Name to open the Subscription form, where you can:**
   - View or update how users are allocated to a Per-User subscription, and how custom tables are allocated to subscriptions that contain custom table entitlements. See **Subscription form**
   - View the applications, plugins, and roles that are included with a subscription.
   - View history reports that provide the usage administrator with subscription status and trend information.

**Subscription form**

Use the Subscription form to view a list of applications that are associated with the subscription and to view or update how resources, such as users or custom tables, are allocated to it.
In any list of subscriptions, click a subscription name to open the Subscription form. Some fields do not appear for ServiceNow Store applications.

**Note:** For information on why a subscription is not in the list, see Why a subscription might not appear in the list.

### Subscription form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
</table>
| Subscription message | If this is an App Engine subscription, the following information appears:  
  - Number of users who can use this subscription.  
  - Total number of custom tables each user can access  
  To learn more about monitoring App Engine subscriptions, see Monitor App Engine subscription usage and compliance. |
| Name             | Name of the subscription.                                                                                                                                                                             |
| Category         | Source of the purchased subscription: ServiceNow platform or ServiceNow Store.                                                                                                                        |
| Type             | Type of subscription:  
  - Per-User  
  - Max User  
  - Capacity  
  - PA Indicator  
  - Unlimited  
  To learn more about subscription types, see Types of subscriptions.                                                                                                                  |
<p>| Start date/End date | Start and end of the subscription period as agreed in your service contract. This information appears in the General section of the service contract for the subscription.                                |
| Display only     | Value of <strong>true</strong> indicates that user allocation or monitoring is not currently supported for the subscription.                                                                                         |
| Cost             | Subscription is <strong>For-fee</strong> or <strong>Free</strong>. Some ServiceNow Store apps are free. You do not allocate resources to free subscriptions.                                                                  |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchased</td>
<td>Number of users, entitlements, or other resources that can be subscribed. Note: Purchases of multiple qualifying subscriptions for certain types of products combine into a single subscription pool, and any usage against that subscription deducts from the common pool. To learn more about pooled subscriptions, see Pooled subscriptions.</td>
</tr>
<tr>
<td>Allocated</td>
<td>Number of currently subscribed users or allocated resources for the subscription. The color codes indicate the used percentage of the subscription. See Configure the color codes for subscription allocation levels.</td>
</tr>
<tr>
<td>Tables included</td>
<td>Number of custom tables that are included with the purchased subscription.</td>
</tr>
<tr>
<td>Tables used</td>
<td>Number of custom tables in production that have been allocated to a purchased subscription with a custom table entitlement. This number increments when you allocate custom tables against the entitlement for the purchased subscription. The color codes indicate the used percentage of the custom table entitlement. See Configure the color codes for subscription allocation levels. To learn more about this process, see Allocate your custom tables to subscriptions.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Limit to purchased</td>
<td>Option to ensure that you do not exceed the purchased subscription limit while attempting to allocate users. The setting affects whether you can use the Allocate selected users button for users in the Pending state.</td>
</tr>
<tr>
<td></td>
<td>Note: The admin role is required to change this setting.</td>
</tr>
<tr>
<td></td>
<td>When an allocation would result in exceeding the purchased subscription limit, the following conditions apply:</td>
</tr>
<tr>
<td></td>
<td>• Limit to purchased selected: You cannot apply the Allocate selected users button on the Pending Users related list.</td>
</tr>
<tr>
<td></td>
<td>• Limit to purchased not selected: You can apply the Allocate selected users button on the Pending Users related list. The color code on the Allocated field changes to red to indicate over-allocation.</td>
</tr>
<tr>
<td></td>
<td>Note: Limit to Purchased functionality does not apply to custom table entitlements.</td>
</tr>
<tr>
<td>Auto-sync user sets</td>
<td>Option to periodically verify all associated user sets for updates and then to update the subscription allocation. The verification process is based on the user set membership settings.</td>
</tr>
<tr>
<td></td>
<td>Note: If you are adding a user that exceeds the subscription limit, the following actions happen:</td>
</tr>
<tr>
<td></td>
<td>• The user is not subscribed.</td>
</tr>
<tr>
<td></td>
<td>• The user is set to the Pending state.</td>
</tr>
<tr>
<td></td>
<td>• The user is listed on the Pending Users related list.</td>
</tr>
</tbody>
</table>
## Related lists on the Subscription form

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscribed Users</td>
<td>List of users who are subscribed to the applications. Users can be added to this list when they are individually subscribed, or when they are members of user sets. To learn more, see <a href="#">Subscription user sets</a>. This related list appears only for Per-User subscriptions.</td>
</tr>
<tr>
<td>User Sets</td>
<td>User sets that were added to the subscription.</td>
</tr>
<tr>
<td>Pending Users</td>
<td>Option that indicates a pending user. When you try to allocate users to a subscription but the subscription limit would be exceeded, the users are not subscribed and are set to the Pending state. You can deallocate some users and allocate other users to the subscription. See <a href="#">Manage users in the Pending state</a>.</td>
</tr>
<tr>
<td>Excluded Users</td>
<td>Excluded users cannot be allocated to the subscription. See <a href="#">Exclude a user from a subscription</a> and <a href="#">Remove a user from the Excluded list</a>. This related list appears only if there are users in the Excluded state.</td>
</tr>
<tr>
<td>Subscription Applications</td>
<td>Applications or application families that are associated with the subscription. Users that you allocate to the subscription are subscribed to the listed applications. On production instances, click the application name to view a listing of published and entitled (unpublished) plugins that are associated with the application. Activation of plugins requires a user role of admin.</td>
</tr>
<tr>
<td>Associated Roles</td>
<td>For Per-User type subscriptions, lists all roles that have been downloaded with the plugin for the application. The Requires Subscription column indicates if users with this role must be allocated to the subscription to stay in compliance. This setting comes from the user role record. To learn more, see <a href="#">Create a role</a>. You might use the roles that are identified as associated roles to construct a user set. See <a href="#">Build a subscription user set</a>.</td>
</tr>
<tr>
<td>Custom Tables</td>
<td>List of subscriptions that contain custom table entitlements. To learn more about custom table entitlements, and how the custom table allocation process works, see <a href="#">Allocating your custom tables to a subscription entitlement</a>.</td>
</tr>
</tbody>
</table>
### Types of subscriptions

The Subscriptions module lists all subscription types that your organization has purchased.

<table>
<thead>
<tr>
<th>Subscription type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Capacity</strong></td>
<td>Your ServiceNow instance auto-allocates resources such as users, devices, software, or nodes to Capacity subscriptions. For example, resources like each CI that Discovery finds or each password reset request.</td>
</tr>
<tr>
<td><strong>Max User</strong></td>
<td>Your organization purchased a subscription for the anticipated maximum number of active ServiceNow users. To monitor overall usage, the instance auto-allocates each active user up to the limit of the Max User subscription.</td>
</tr>
<tr>
<td><strong>PA Indicator</strong></td>
<td>Your organization purchased a subscription for an application family that uses Performance Analytics capabilities (for example, PA for ITSM or PA for Service Management). The PA admin creates indicators on tables that are used by the applications.</td>
</tr>
<tr>
<td><strong>Per-User</strong></td>
<td>Your organization purchased a subscription for the number of fulfiller users for subscription applications and capabilities. By default, the instance can monitor and report on usage of the application by both subscribed users and users who are not subscribed. See <a href="#">Allocating users to a Per-User subscription</a>.</td>
</tr>
<tr>
<td><strong>Unlimited</strong></td>
<td>ServiceNow Store apps only. Your instance auto-allocates and tracks <em>active users</em> to an Unlimited subscription. There is no limit to the number of users that can be allocated. An active user is any user in the sys_user table that has a user id and has the <strong>Active</strong> field set to true.</td>
</tr>
</tbody>
</table>
Pooled subscriptions
When you purchase multiple qualifying subscriptions for certain types of products, such as IntegrationHub, those individual subscriptions combine into a single subscription pool. Any usage against that subscription deducts from the common pool.

For example, if you buy an IntegrationHub spoke with 1,000 entitlements, and another type of spoke with 500 entitlements, they combine into a common pool of 1,500 entitlements. This total entitlement pool appears in the **Purchased** field in the Subscription form. Qualifying entitlement usage for either type of spoke automatically deducts from this common pool.

**Why a subscription might not appear in the list**
The Subscriptions list displays the subscriptions that your organization has purchased. There are, however, several types of non-subscription items that do not appear in the list.

**Why does my subscription not appear in the Subscriptions list?**

- You might not see all subscription services that you have purchased because the Subscription Management application does not yet allow management of some subscription services.
- The subscription may have expired. The page lists only subscriptions that are currently active. To view expired subscriptions as well, set the list filter to **All**.
- Subscription data arrives on production instances only.
- Self-hosted instances do not receive subscription information.
- Subscriptions that are marked as **Display only** do not currently support resource allocation or monitoring.

**Why is the Subscriptions list empty?**

- The subscription information might not yet have arrived. The data is downloaded daily.

**View the applications and plugins that are included with a subscription**
You can activate a plugin that is associated with a for-fee subscription only if your organization has purchased the subscription.

Role required: usage_admin or admin

1. On your production instance, navigate to **Subscription Management > Subscriptions**. The page lists all active subscriptions for your organization. If a subscription does not appear in the list, contact your ServiceNow account representative to purchase the subscription. Some subscriptions do not appear for other reasons. See **Why a subscription might not appear in the list**.

2. Click a subscription name and then, on the Subscription form, click an application name in the Subscription Applications related list. (A subscription can include multiple applications.) The page lists the plug-ins that are associated with the application.

**View the roles that are associated with the plugin for a subscription application**
The Application Roles related list includes all roles that are loaded with the plugin for an application. The roles in the list form a good basis for constructing a user set.

Role required: usage_admin or admin
1. On your production ServiceNow instance, navigate to **Subscription Management > Subscriptions**, and then click a subscription name.

   The Application Roles related list includes all roles that are loaded with the plugin for an application. The fulfiller type roles in the list that are subscription roles form a good basis for constructing a user set.

2. Use the list as a basis for creating a user set.

**View Subscription Management history reports**

History reports provide the usage administrator with subscription status and trend information for the organization.
Role required: usage_admin or admin

Follow the How to instructions in the table.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>How to</th>
</tr>
</thead>
</table>
| Subscription histories        | Concise data on subscription downloads and updates for your organization.    | a. Navigate to Subscription Management > Subscriptions and then click a subscription Name.  
                             |                                                                              | b. On the Subscription form, click the View Subscription History related link.  
                             |                                                                              | c. The Subscription History pop-up lists the operations on subscriptions for this ServiceNow instance. Click an Operation to view details. |
| Histories of subscription users| For each Per-User subscription, concise historical data on changes in subscription state for users: when users were subscribed and when they were unsubscribed, excluded, or unexcluded. | a. Navigate to Subscription Management > Subscriptions and then click the Name of a Per-User subscription.  
                             |                                                                              | b. On the Subscription form, click the View User Subscription History related link.  
                             |                                                                              | c. The User Subscription History pop-up lists the operations on user subscription state for the specified subscription. Click a User State to view details of a change in subscription state for a user.  
                             |                                                                              | • User State: Lists the change in the user state: subscribed/unsubscribed and excluded/unexcluded.  
                             |                                                                              | • Allocation Source: Lists the name of the user set that acted as the source of the user.  
                             |                                                                              | • Allocation Type: Lists the method for allocating the user to the subscription: user set or individual.  
                             |                                                                              | • Operation time and Created by: Lists the time stamp of change and the admin who made the change.  |
| Histories of subscription user sets | Data on when subscription user sets were created, updated, or deleted.        | a. Navigate to Subscription Management > Subscription User Sets and then click the Name of a user set.  
                             |                                                                              | b. On the Subscription User Set page, click the View User Set History related link.  
                             |                                                                              | c. The User Set History pop-up lists the operations on user sets for the specified subscription. Click an Operation to view details. |

Allocating users to a Per-User subscription

Use the Subscriptions module to allocate users to all Per-User subscriptions that your organization has purchased.
Example: allocate users to a Per-User subscription

In this example, your organization purchased a subscription for 200 fulfiller users. You, the usage admin, can therefore specify the 200 users—the *subscribed users*—who have the right to use the application family on your production instance. You can allocate users either individually or by adding user sets to the subscription.

**Note:** User sets are the preferred automated method for managing the pool of users who are allocated to a subscription. Once you configure and allocate a user set, the system regularly updates the list of members based on the conditions that you specified. You do not need to manage individual users.
Guidelines for allocating users

• You allocate users only to Per-User subscriptions. The instance auto-allocates and reports on monthly usage for all other subscription types.
• When you add a user set to a subscription, the system allocates all users in the user set, up to the purchased subscription limit.
• In the case that adding the users in a user set would exceed the subscription limit, then none of the users in the user set are subscribed. Instead, all users in the user set are set to the Pending state and are listed on the Pending Users related list. Users that are currently subscribed are not affected. See Manage users in the Pending state.
• You can unsubscribe any user as needed.
• You can exclude users. Excluded users cannot be allocated to a subscription individually or through a user set. At any time, you can remove a user from the list of excluded users.

Note: If you unsubscribe a user who is a member of a user set that is associated with an auto-synced subscription, the user will be resubscribed in the next synchronization cycle. To remove such a user, exclude the user. See Exclude a user from a subscription.

Methods for allocating users

• Define user sets and then add user sets to the subscription
• Allocate individual users to the subscription (as many as are required)

Overview of the procedure for allocating users

1. Allocate users to the subscription using one or both of the following methods:
   • Build one or more user sets and add the user sets to the subscription
   • Allocate individual users

2. After you have allocated users to the subscription, you can add or remove user sets and individual users as needed. In addition, you can exclude individual users as needed.

Note: Some subscriptions come with an entitlement of custom tables that can be created in a production instance. To learn more about custom table entitlements and allocations, see Allocating your custom tables to a subscription entitlement.

Subscription user sets

User sets make it easy to specify which users should be allocated to a subscription. You can use roles, user groups, or both roles and groups as the conditions for a user to be a member of a user set (for example, everyone with the fulfiller role in the “IT department” group).

Auto-sync

When you add a user set to a subscription, the system attempts to subscribe all users in the user set. The system updates the members in a user set whenever a user update causes the user to meet or fail to meet the criteria for the user set. For example, if a user loses the “fulfiller user” role, the user is removed from the user set.
To make subscriptions self-maintaining, you can *auto-sync* a subscription. The system then regularly subscribes or unsubscribes users based on updates to the user sets that are assigned to the subscription. The option is described in *Auto-sync a subscription to user set updates*.

**Note:** Even if you select the *Auto-sync with user sets* option, you can update, remove, or manually synchronize the user set at any time.

### How users are subscribed and unsubscribed

- When you *add* a *user set* to a subscription, the system allocates all users in the user set to the subscription, up to the purchased subscription limit.
- You can add a user set to any number of subscriptions.
- Users that are allocated from multiple user sets are subscribed only one time.
- In the case that adding the users would exceed the subscription limit, then none of the users in the user set are subscribed. Instead, all users in the user set are set to the *Pending* state and are listed in the Pending Users related list.
- When you remove a user set from a subscription, the system attempts to unsubscribe all users in the set. If a user is added from another user set, however, the user is not unsubscribed.
- Users that the usage admin has flagged as *excluded* are not allocated, even if other members of the user set are allocated. The usage admin can *unexclude* a user so that the user can be allocated.

### Why a user is not subscribed when you add a user set

- The user set is empty (contains no users).
- The user had been excluded from the subscription.
- The user had already been directly allocated
- Another user set added the user (duplicate user)
- A user could not be allocated because adding the user would exceed the subscription limit. In this case, all users in the user set are set to the *Pending* state. The names of the users are listed in the Pending Users related list.

### Why a user is not unsubscribed when you remove a user set

- The user set is empty (contains no users).
- The user was already directly allocated
- The user is added from another user set

### Build a subscription user set

You can create a user set using either or both of two methods: Configure a filter (for example, filter by role) that selects particular users from the User `[sys_user]` table or specify a particular set of user groups from the Group `[sys_user_group]` table.

Role required: usage_admin or admin

1. Navigate to Subscription Management > Subscription User Sets.
2. On the Subscription User Sets page, click New and then enter a unique Name (for example, *Fulfiller users in the IT department*) and Description for the user set.
3. To specify a user set by filtering users:
   a) In the **Source** field, select **User [sys_user]**.
   b) Specify the filters that determine which users to extract from the table. The extracted users make up the user set. For example, filter for `[role] [is] [itil]`. The **Conditions** setting is a standard ServiceNow condition builder.

   **Tip:** The **Application Roles** related list on the Subscriptions page includes all roles that are loaded with the plugin for the application. The roles in the list [that are identified as Subscription roles] form a good basis for constructing a user set. See View the roles that are associated with the plugin for a subscription application.

   c) Click ( ) to view the number of users that the filter generates. Members of the user set appear in the Subscription User Set Members related list.

4. To specify a user set based on user groups that should be included in the set:
   a) In the **Source** field, select **Group [sys_user_group]**
   b) Unlock the **Groups** box and add appropriate groups.
   c) Click ( ) to view the number of users that the filter generates. Members of the user set appear in the Subscription User Set Members related list.

5. When the Subscription User Set Members related list is correct, click **Submit** or **Update**. The user set that you created is available to add to any subscription.

### Add a user set to a subscription
When you add a user set to a subscription, all users in the user set are allocated to the subscription.

**Role required:** usage_admin or admin

1. Navigate to **Subscription Management > Subscriptions**.
2. Click the **Name** of the Per-User subscription to allocate users to.
3. On the **User Sets** related list, click **Edit**.
4. The Add User Sets form displays the list of user sets that you can add. Move the desired user sets from the **Collection** list into the **User Sets** list and then click **Save**. The users in the list are allocated to the subscription and the number of subscribed users is updated.

   **Note:** In the case that adding the users would exceed the subscription limit, then none of the users in the user set are subscribed. Instead, all users in the user set are set to the **Pending** state and are listed in the Pending Users related list. Users that are currently subscribed are not affected. See **Manage users in the Pending state**.

5. Optional: You can configure any subscription to check associated user sets for updates regularly and then update the list of subscribed users accordingly. On the Subscription form, select **Auto-sync with user sets**.

   **Note:** If you do not select the **Auto-sync with user sets** option, then the user sets that you add to the subscription are never updated and the list of subscribed users does not auto-update over time.

6. On the Subscription form, click **Update**.
**Auto-sync a subscription to user set updates**
You can configure any subscription to check user sets regularly to find users who were added or removed. The system regularly subscribes or unsubscribes users based on updates to user sets.

Role required: usage_admin or admin

If the system cannot allocate a user because adding the user would exceed the subscription limit, the user is set to the **Pending** state and is listed in the Pending Users related list.

1. Navigate to **Subscription Management > Subscriptions**.
2. Click the **Name** of the Per-User subscription to update.
3. On the **Subscription** form, select **Auto-sync user sets**.
4. Optional: On the **Subscription** form, click **Sync Now** to synchronize and update the list of subscribed users immediately.

**Remove a user set from a subscription**
When you remove a user set from a subscription, the system attempts to unsubscribe all users in the set. User sets are removed regardless of the **Auto-sync with user sets** setting.

Role required: usage_admin or admin

1. Navigate to **Subscription Management > Subscriptions**.
2. Click the **Name** of the Per-User subscription.
3. In the User Sets list, select all user sets to remove.
4. In the **Actions on selected rows** list, select **Remove From Subscription**. On the Remove User Set from Subscription pop-up, click **Remove**.
   All users in the selected user sets are unsubscribed. If users in the user sets are pending, then the users are removed from the Pending Users list.

**Delete a subscription user set**
You can delete a subscription user set only if no subscriptions use the user set.

Role required: usage_admin or admin

> **Note:** Deleting a user set is a permanent action — the user set will no longer exist. In contrast, you can remove a user set from a subscription to unsubscribe all users in the user set — the user set will still exist.

1. Ensure that the user set is not used by any subscription.
2. Navigate to **Subscription Management > Subscription User Sets** and select the user set.
3. Click **Delete**.

**Allocate an individual user from the Subscription form**
In addition to adding user sets to a subscription, you can add individual users directly. Users that you allocate directly are subscribed immediately.

Role required: usage_admin or admin
Note: A user set, not individual allocation, is the preferred automated method for managing the pool of users who are subscribed to an application. Once you configure and allocate a user set, you do not need to manage individual users.

1. Navigate to Subscription Management > Subscriptions.

   ![Subscription Management Table]

2. Click the Name of the Per-User subscription to allocate users to.

3. Optional: On the Subscription form, to ensure that you do not exceed the purchased subscription limit, click Limit to purchased.

4. On the Subscribed Users related list, click Edit to view a listing of the users you can add.

5. Move the desired users from the Collection list into the Subscribed Users list.

6. Click Save.

   The selected users are allocated to the subscription and the Allocated value is updated. If allocating a user would exceed the subscription limit, the user is not subscribed. Instead, the user is set to the Pending state and is listed in the Pending Users related list. See Manage users in the Pending state.

7. Click Update on the Subscription form.

Allocate an individual user from the User Record form

To simplify the process of setting up user capabilities, you can allocate or deallocate an individual user to a subscription while viewing the user data on the User form. Users that you allocate directly are subscribed immediately.

Role required: usage_admin or admin
Note: A user set, not individual allocation, is the preferred automated method for managing the pool of users who are subscribed to an application. Once you configure and allocate a user set, you do not need to manage individual users.

1. Navigate to User Administration > Users and then click the Name of the user. The User form opens.
2. On the Manage Subscriptions related list, click Edit.
   The Edit Members slushbucket lists the subscriptions that you can allocate the user to.
3. To allocate the user, move a subscription from the Collection list into the Manage Subscriptions list.
4. Click Save.
   The selected users are allocated to the subscription and the Allocated value is updated. If allocating a user would exceed the subscription limit, the user is not subscribed. Instead, the user is set to the Pending state and is listed in the Pending Users related list. See Manage users in the Pending state.
5. To deallocate the user, move a subscription from the Manage Subscriptions list into the Collection list.
6. Click Update on the User form.
   The Subscriptions related list is updated to list all subscriptions that the user is allocated to and the applications that the user is subscribed to.

Manage users in the Pending state

Users are set to the Pending state when adding the users would exceed the subscription limit (the Purchased value).

Role required: usage_admin or admin

Users are added to the Pending Users list when you attempt to allocate users in the following situations:

- User sets: If adding the user set exceeds the subscription limit, the user set is not added and all users in the set are set to the Pending state.
- Individual user: If allocating a user directly would exceed the subscription limit, the user is not subscribed and is instead set to the Pending state.

1. Navigate to Subscription Management > Subscriptions.
2. Click the Name of the Per-User subscription.
3. In the Pending Users related list, select all users to update.
4. In the Actions on selected rows list, select an action.

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocate selected users</td>
<td>Allocates the users to the subscription and removes the user from the Pending Users list.</td>
</tr>
<tr>
<td></td>
<td>• If the Limit to purchased option is selected and adding the selected users would exceed the subscription limit (the Purchased value), then the action is not allowed.</td>
</tr>
<tr>
<td></td>
<td>• If the Limit to purchased option is not selected and adding the selected users would exceed the subscription limit (the Purchased value), then the system displays a pop-up to notify you.</td>
</tr>
<tr>
<td>Exclude from subscription</td>
<td>Excludes the user and removes the user from the Pending Users list.</td>
</tr>
<tr>
<td></td>
<td>Excluded users cannot be allocated to the selected subscription. The auto-sync process does not add excluded users.</td>
</tr>
<tr>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected users from the Pending Users list and performs no other action.</td>
</tr>
</tbody>
</table>

**Unsubscribe a user**

When you remove a user from a subscription, the user is unsubscribed.

Role required: usage_admin or admin

1. Navigate to **Subscription Management > Subscriptions**.
2. Click the **Name** of the Per-User subscription.
3. In the Subscribed Users list, select all users to unsubscribe.
4. In the **Actions on selected rows** list, select **Remove from subscription** and then click **Remove** on the pop-up.

   **Note:** If you unsubscribe a user who is a member of a user set that is associated with an auto-synced subscription, the user will be resubscribed in the next synchronization cycle. To remove such a user, exclude the user.

**Exclude a user from a subscription**

You can exclude users. Excluded users cannot be allocated to a specified subscription. The auto-sync process does not add excluded users.

Role required: usage_admin or admin

1. Navigate to **Subscription Management > Subscriptions**.
2. Click the **Name** of the Per-User subscription.
3. In the **Subscribed Users** list, select all users to exclude.
4. In the **Actions on selected rows** list, select **Exclude from subscription** and then click **Exclude** on the pop-up.

**Remove a user from the Excluded list**

You can unexclude a user so that the user can be allocated to a subscription.

Role required: usage_admin or admin

1. Navigate to **Subscription Management > Subscriptions**.
2. Click the **Name** of the Per-User subscription.
3. In the Excluded Users related list, select all users to unexclude.
4. In the **Actions on selected rows** list, select **Delete** and then click **Delete** on the pop-up.
   The selected users are no longer excluded and are removed from the Excluded Users related list. No other action is taken.

   **Note:** The users are not yet allocated to the subscription. You must manually add the users or synchronize the associated update set. On the **Subscription** form, click **Sync Now** to synchronize and update the list of subscribed users immediately.
Allocating your custom tables to a subscription entitlement

Allocate custom tables you create in production instances to subscriptions that include custom table entitlements. Performing this task on a consistent basis enables you to track custom table subscription compliance over time.

Custom table entitlements

A custom table is defined as any non-ServiceNow provided table that you create or install on the Now Platform. Some tables are exempted from being classified as a custom table.

Note: For a detailed description of custom table use rights, and a listing of exempt ServiceNow provided tables, see the Custom Table Guide on http://www.servicenow.com/upgrade-schedules.html.

You can freely create or install custom tables on a non-production instance. However, creation or installation of custom tables on a production instance requires a custom table entitlement that is granted with the purchase of a product subscription. For example, a single subscription might include a total entitlement of 50 custom tables.

Note: A custom table entitlement is an individual component of a subscription, but is not a type of subscription itself. Standard licensing metrics, such as fulfiller, requester, and unrestricted, and the subscription types, such as Per-User and Capacity, still apply to subscriptions with custom table entitlements. To learn more about licensing metrics and subscription types, see:

- Subscription Management administration
- Types of subscriptions

Allocating custom tables to custom table entitlements

After you finalize the purchase of a subscription with a custom table entitlement, the entitlement is delivered, with related subscription data, to your production instance. The subscription and custom table entitlement data appear in a subscription record in Subscription Management.

As your developers create and deploy new custom tables on your production instance, you use the Subscription form to allocate them to individual subscriptions. You can use Subscription Management dashboards to monitor the current table allocations and their compliance statuses, and take corrective action as needed. To learn more about how this allocation process works, see:

- Allocate your custom tables to subscriptions
- Monitor custom table allocations and subscriptions

Custom table entitlements

Scenario: Your organization has purchased three subscriptions and each has differing table entitlements.

For example, Subscription 1 has an entitlement of 100 fulfillers and a total entitlement of 50 custom tables. Subscription 2 has 20 fulfillers and a total entitlement of 25 custom tables. Subscription 3 has 5000 users and a total entitlement of five custom tables. In total, you can manually allocate up to 80 custom table to these three subscriptions as you create them in your production instance.
Multiple subscriptions with custom table entitlements

<table>
<thead>
<tr>
<th>Subscription</th>
<th>User/custom table entitlements</th>
<th>Can manually allocate up to entitlement quantity of</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>100 fullfillers/50 custom tables</td>
<td>50</td>
</tr>
<tr>
<td>2</td>
<td>20 fullfillers/25 custom tables</td>
<td>25</td>
</tr>
<tr>
<td>3</td>
<td>5000 users/5 custom tables</td>
<td>5</td>
</tr>
</tbody>
</table>

Allowing grandfathered tables on an instance

Sometimes an extra subscription with a grandfathered table entitlement may be delivered to your production instance. This type of subscription triggers an automatic allocation of grandfathered tables to the grandfathered entitlement, up to its specified maximum limit. This one-time process ensures that custom tables that currently exist in a production instance do not count against custom table entitlements for a new ServiceNow subscription. You can not manually allocate these grandfathered tables to a subscription entitlement.

Once a grandfathered table is auto-allocated to a subscription that has a grandfathered entitlement, this mapping is permanent. Deleting a grandfathered custom table does not free up a custom table entitlement.

Allowing grandfathered tables on an instance

Scenario: You purchased three new subscriptions, with a total of 80 custom table entitlements. An extra subscription with an entitlement for 23 grandfathered tables has also been delivered to your instance. The grandfathered tables are visible within Subscription Management. This subscription triggers an automatic allocation of the custom tables that currently exist in your production instance, up to its 23 table limit. These subscriptions result in a total custom table entitlement of 103, of which you can manually allocate the remaining 80 as you create custom tables in your production instance.

Multiple subscriptions with legacy and custom table entitlements

<table>
<thead>
<tr>
<th>Subscription</th>
<th>Custom table entitlements</th>
<th>Can manually allocate up to entitlement quantity of</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legacy subscription</td>
<td>Up to 23 legacy tables auto-allocated upon subscription arrival</td>
<td>0 (legacy tables auto-allocated)</td>
</tr>
<tr>
<td>New Subscription 1</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>New Subscription 2</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>New Subscription 3</td>
<td>5</td>
<td>5</td>
</tr>
</tbody>
</table>

Custom table subscription allocation life cycle

The life cycle begins with the purchase of a subscription, and it continues with the allocation of custom tables. The cycle ends with the monitoring of custom table allocations over time.
3. Monitor custom table allocation over time
A subscription that contains a custom table entitlement is delivered to your production instance. Sometimes an extra subscription with a grandfathered table entitlement may also be delivered that triggers an automatic allocation of legacy custom tables to the entitlement. Subscription Management records are automatically updated to reflect the new subscription and grandfathered table entitlement. The subscription is ready for you to administer.

2. Allocate custom tables to custom table entitlements.
   - As new custom tables are deployed on a production instance, you allocate them to the relevant custom table entitlement from the subscription record.
   - Tables can be allocated to any subscription with a custom table entitlement, up to the entitlement limit.

3. Monitor custom table allocation over time.
   - Reports provide the current usage of each custom table entitlement, as well as usage over time.

Allocate your custom tables to subscriptions
Allocate specific custom tables to subscriptions that include a custom table entitlement. You perform this allocation process to maintain and track custom table compliance over time. Tracking custom table compliance ensures that your organization does not run out of custom table entitlements and enables you to plan your future subscription purchases.

Role required: usage_admin or admin

1. Navigate to Subscription Management > Subscriptions.
2. Click the Name of the purchased subscription you want to allocate custom tables to.
   - If a subscription contains an entitlement of custom tables, you can find the following information about the entitlement:

   **Tables included**
   Number of custom tables that are included in the custom table entitlement for the subscription.

   **Tables used**
   Number of custom tables in production that have been allocated to a subscription with a custom table entitlement. This number increments when you allocate custom tables against the entitlement for the subscription.
   - The color coding indicates the percentage of custom tables that have been already allocated. To learn more about how to configure color coding, see Configure the color codes for subscription allocation levels.

3. On the Custom Tables related list, click Edit.
   - A listing of all custom tables in the production instance that are eligible for allocation to the subscription appears in the Collection list.

   **Note:** Not all custom tables appear in this list. Examples of tables that do not appear in the list include:
   - Custom tables that are already allocated to a different subscription with a custom table entitlement.
   - Custom tables that are accounted for in the process.
   - Custom tables that are exempted.
4. Allocate specific custom tables to the subscription by moving them from the Collection list to the Custom Tables Inventory List.

You can only select the custom tables that meet the criteria that was outlined in the note of the previous step.

5. On the Subscription form, click Save, and then click Update.

The selected custom tables are allocated to the subscription, and the Tables used value in the Subscriptions list and form is incremented.

**Monitoring how your resources are allocated for subscriptions**

Manage and monitor how resources, such as users, custom tables, or nodes, are allocated to your organization's subscriptions throughout the life cycle of your subscriptions. By monitoring the usage of your subscribed applications, you can make better decisions about your subscription purchases.

A typical subscription life cycle is as follows:

1. You receive and view subscriptions after you are notified by email that subscription information has successfully downloaded to your instance. See View your subscription applications and allocation levels.

2. You allocate your fulfiller users to Per-User subscriptions by using the Subscriptions module. Allocation is typically a one-time task with minor maintenance. To learn how to allocate users to this type of subscription, see Allocating users to a Per-User subscription.

   **Note:** The Now Platform instance automatically allocates all other subscription types.

3. If a subscription contains a custom table entitlement, you allocate the custom tables that are created in a production instance to the subscription entitlement. To learn how to allocate custom tables, see Allocating your custom tables to a subscription entitlement.

4. Monitor and adjust the subscription usage by verifying:
   - How many users are subscribed to specific subscriptions.
   - If you can allocate more users to specific subscriptions.
   - If you see users who are not subscribed. For example, you see out-of-policy users.
   - If some subscriptions are over-allocated. For example, too many subscribers might be allocated to a specific subscription.

   To learn how to monitor and adjust the subscription usage, see Monitor how resources are allocated to subscriptions and Monitor subscription compliance.

5. You review the historical activity of the subscriptions by verifying:
   - How usage patterns have changed over time.
   - If a particular application has a high demand.

   To learn about reviewing historical subscription activity, see View your subscription applications and allocation levels and View Subscription Management history reports.

6. You review the subscriptions that your organization has purchased and verify their allocation levels. To learn how to review subscriptions, see View your subscription applications and allocation levels.

**Monitor how resources are allocated to subscriptions**

Monitor how users and resources, such as nodes, transactions, or custom tables, are allocated to your subscriptions over time.
Role required: usage_admin or admin

You can do the following actions:

- Monitor how your resources, such as discovered nodes or password reset requests, use Capacity subscriptions.
- Monitor if the custom tables that are created in your production instance have been allocated to subscriptions with custom table entitlements.
- Plan and budget for upcoming or future subscription needs.
  - Assess whether you have allocated too many fulfiller users to a Per-User subscription. You might need to deallocate some users or purchase a subscription for more users.
  - Assess whether you have allocated too few fulfiller users to a Per-User subscription. You might need to allocate more users.
- Determine whether users who are not subscribed are accessing a subscription application.

Navigate to Subscription Management > Subscription Overview.

The Expired Subscriptions report lists all subscriptions where the service contract term has expired (the end date has passed). Assess whether to renew any subscription that has expired.

The following data appears for a single subscription (at least one month of data is required) in each Subscription Metrics chart:

**Purchased**

The number of resources that were purchased for the subscription.

**Allocated**

The average number of users for the month who are allocated to the subscription.

**Non-subscribed users**

The average number of individual users who performed fulfiller actions in the associated applications without being subscribed to the applications. You can click a data point to view an application.

In the example, the organization updated the purchased subscription from 15 to 20 users in November 2015. In April 2016, the usage administrator allocated an average of 19 users. In addition, one user
who was not subscribed performed fulfiller actions in an application that was associated with the subscription.

The **Subscription Allocation** chart is a listing of all subscriptions and their allocation status as described in the table.
## Subscription Allocation report

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>One of the following values:</td>
</tr>
<tr>
<td></td>
<td>• For Per-User, Max User, PA Indicator, and Unlimited subscriptions: Name of</td>
</tr>
<tr>
<td></td>
<td>the subscription that your organization purchased.</td>
</tr>
<tr>
<td></td>
<td>• For Capacity subscriptions: Name of the product, standard offering,</td>
</tr>
<tr>
<td></td>
<td>option, or add-on that your organization purchased.</td>
</tr>
<tr>
<td></td>
<td>Click a subscription Name to open the Subscription form, where you can</td>
</tr>
<tr>
<td></td>
<td>view or update how users are allocated to the subscription.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of subscription: Max User, Per-User, Capacity, or Unlimited.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Start and end of the subscription period.</td>
</tr>
<tr>
<td>End Date</td>
<td></td>
</tr>
<tr>
<td>Purchased</td>
<td>Number of users or other resources that the subscription permits to access</td>
</tr>
<tr>
<td></td>
<td>the subscription application.</td>
</tr>
<tr>
<td></td>
<td>For custom tables, it is the number of custom tables that comprise the</td>
</tr>
<tr>
<td></td>
<td>entitlement in the purchased subscription.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To learn more about custom table entitlements and allocations,</td>
</tr>
<tr>
<td></td>
<td>see Allocating your custom tables to a subscription entitlement.</td>
</tr>
<tr>
<td>Allocated</td>
<td>Number of currently allocated users or other resources, such as nodes or</td>
</tr>
<tr>
<td></td>
<td>transactions.</td>
</tr>
</tbody>
</table>

### Monitor subscription compliance

Use the Compliance Overview module to monitor fulfiller actions by subscribed users and by users who are not subscribed to an application that your organization has purchased. In addition, a chart shows usage for applications where your organization has not yet purchased a subscription.

Role required: usage_admin or admin

Navigate to **Subscription Management > Compliance Overview** to view the following charts:

- The **Unique Application Users** chart shows the number of individual subscribed users who performed fulfiller actions in the application. Each user is counted one time only, regardless of number of accesses.
- The **Unique Out-of-Policy Users** chart shows the number of individual users who performed fulfiller actions in the application without being subscribed to the application. Each user is counted
Monitor custom table allocations and subscriptions

Monitor how many custom tables that are in your instance are allocated to subscriptions. Monitoring custom table allocations is a critical task in ensuring that your organization remains in compliance with subscription entitlements.

Role required: admin

1. Navigate to Subscription Management > Custom Table Subscription Overview.
2. Click a tile for more information.

<table>
<thead>
<tr>
<th>Tile</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Custom Tables</td>
<td>Total number of custom tables that you created your production instance.</td>
</tr>
<tr>
<td></td>
<td>Click the tile to view a listing of subscriptions you allocated the custom</td>
</tr>
<tr>
<td></td>
<td>tables to.</td>
</tr>
<tr>
<td>Tables not Mapped</td>
<td>Total number of custom tables that you have not allocated to custom table</td>
</tr>
<tr>
<td></td>
<td>entitlements in purchased subscriptions.</td>
</tr>
<tr>
<td></td>
<td>Click the tile to view a listing of the custom tables you have not allocated</td>
</tr>
<tr>
<td></td>
<td>to custom table entitlements in subscriptions.</td>
</tr>
<tr>
<td>Custom Tables per Subscription</td>
<td>Number of custom table your subscriptions include.</td>
</tr>
<tr>
<td></td>
<td>It includes the number of custom tables that you allocated to each</td>
</tr>
<tr>
<td></td>
<td>subscription.</td>
</tr>
</tbody>
</table>

Monitor App Engine subscription usage and compliance

Track your App Engine subscriptions with the App Engine Usage dashboard. Use this dashboard to better understand how to manage subscription compliance.

App Engine subscriptions entitle you to develop applications and deploy custom tables in production instances. The App Engine Usage dashboard provides information about each type of active App Engine subscription in your instance and its current compliance status.

For each type of App Engine subscription present on your instance, this compliance dashboard lists:

- The total number of users that are currently allocated to each subscription.
- The number of custom tables that each user in the subscription is entitled to access.
- The list of specific users that are counted against each App Engine subscription.

The dashboard also indicates unlicensed App Engine subscription usage, so you can correct any compliance issues by user, role, or group. Unlicensed usage includes:

- Too many users that are allocated to any given App Engine subscription.
- Individual users with access to more custom tables than are allowed by available entitlements.

Analyze App Engine subscription compliance

Analyze the App Engine Usage dashboard to get a good understanding of your App Engine subscription compliance, and any issues affecting subscription compliance that may require correction.
Role required: usage_admin or admin

1. Navigate to **Subscription Management > App Engine Usage**.
2. To view the users or roles assigned to a specific App Engine subscription, click the subscription’s corresponding tile.

<table>
<thead>
<tr>
<th>Tile</th>
<th>Description</th>
</tr>
</thead>
</table>
| Subscription  | **n/n allocated**  
Total number of users that are currently allocated to the selected App Engine subscription and the total number of users who are licensed to use it. For example,  
a. If **105/100** appears, the subscription is not in compliance because it has 105 currently allocated users, while only 100 users are entitled to use the subscription. A red vertical bar appears, indicating that the subscription is over-allocated and out of compliance.

**Note:** To fix this situation, you must remove 5 users from the subscription. To learn how to remove users, see **Remove individual user access to a custom table by role or group** or **Remove access to a custom table for large numbers of users**.

b. If **85/100** appears, then the subscription is in compliance because it has 85 currently allocated users, and 100 users are entitled to use the subscription. A green vertical bar appears, indicating that the subscription is in compliance.

**Note:** Both of these scenarios apply for all types of App Engine subscriptions.  

**n–n custom tables**  
Total number of custom tables that each user can access for the selected App Engine subscription. For example, if **1-5** appears, a Starter subscription lets each entitled user to access from 1 through 5 custom tables.

<table>
<thead>
<tr>
<th>Tile</th>
<th>Description</th>
</tr>
</thead>
</table>
| Unlicensed    | Red vertical bar and an **Unlicensed** message appears, indicating the unlicensed use of any of the App Engine subscriptions:  
• Users with access to more custom tables than allowed by any purchased App Engine subscription that is present on the instance.  
• Total number of tables that are unlicensed, or over-allocated, based on the total of all purchased App Engine subscriptions. |
3. To view the individual users that are assigned to the selected subscription, click the Users related list.

**Users related list**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Names of the users who can access the selected subscription. Click a user to view the user’s profile and the related lists of the custom tables and custom applications that they can access.</td>
</tr>
</tbody>
</table>

**Note:** To learn more about how to manage user compliance, including how to remove individual users that are assigned to an App Engine subscription, see Remove individual user access to a custom table by role or group.

<table>
<thead>
<tr>
<th>Entitled Custom Tables</th>
<th>Number of entitled custom tables per user. It is the total number of custom tables that each user can access for the selected subscription.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entitled Custom Applications</td>
<td>Number of entitled custom applications per user. It is the total number of custom applications that each user can access for the selected subscription.</td>
</tr>
</tbody>
</table>

4. To view the roles that grant access to the custom tables for the selected subscription, click the Roles related list.

**Roles related list**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roles Granting Access</td>
<td>Names of the individual role that grants custom table access to users that are counted in the selected subscription. Click a role to view the users that are associated with the role.</td>
</tr>
</tbody>
</table>

**Note:** To learn more about how to manage roles, including how to remove the roles that grant access to custom tables in an App Engine subscription, see Remove access to a custom table for large numbers of users.

<table>
<thead>
<tr>
<th>Entitled Custom Tables</th>
<th>Names of the custom tables that are granted access by the role.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entitled Custom Applications</td>
<td>Names of the custom applications that are granted access by the role.</td>
</tr>
<tr>
<td>Users in Subscription</td>
<td>Names of the users in the associated roles.</td>
</tr>
</tbody>
</table>

**Note:** To learn more about how to manage role compliance, see Remove access to a custom table for large numbers of users.
Remove individual user access to a custom table by role or group

Remove an individual user’s access to a role or group to fix situations where too many users have access to custom tables for the subscription.

Role required: usage_admin or admin

The Users related list in the App Engine Usage dashboard lets you view all users who currently use App Engine subscriptions. You can select any user and view their user profile. The user profile lists each custom table and related custom application that the user can access.

1. Navigate to Subscription Management > App Engine Usage.
2. To view the users or roles that are assigned to a specific App Engine subscription, click a subscription tile.
3. In the Users related list, click an individual user to view their standard user profile.
   To learn more about the standard user profile, see User profile page.
4. Click the Entitled Custom Tables related list to view information about the custom tables that the user can access for the subscription.

Entitled custom tables related list

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Name of the custom table that the user is entitled to access.</td>
</tr>
<tr>
<td>Application</td>
<td>Name of the custom application that the custom table belongs to. <strong>Global</strong> appears if the custom table is for global use.</td>
</tr>
<tr>
<td>Role</td>
<td>Role(s) that grant the user access to the table.</td>
</tr>
</tbody>
</table>

5. To remove the selected user from the subscription, select a line in the Entitled Custom Tables listing.
6. From Actions on selected rows, click Remove user's access to table.
7. When the Remove User from Role confirmation dialog appears, click OK.
   If you receive a message stating that access to the table was granted via an inherited role or group, you must instead remove the user from the group:
   • Click the Groups related list.
   • Select the user that you want to remove.
   • From Actions on selected rows, click Delete.
   • When the confirmation dialog appears, click Delete.

8. To formally remove the user's access to the custom table, click Confirm when the final Remove User from Role confirmation dialog appears.

Remove access to a custom table for large numbers of users

Adjust roles or remove multiple users from those roles by granting custom table access in the subscription as needed. Use the Roles related list in the App Engine Usage dashboard to view the roles that grant user access to custom tables in a selected App Engine subscription.

Role required: usage_admin or admin

This procedure is similar to the procedure for removing custom table access for an individual user or smaller number of users. However, you may need to remove custom table access for several hundred, or several thousand users. Rather than doing this one by one, you can either:

• Remove the role or roles that grant access to the custom tables for these groups of users, depending on permissions
• Remove large groups of users from these roles.
For example, you would use this procedure if you are developing an application for use in North America and need to remove access for all European users.

1. Navigate to Subscription Management > App Engine Usage.
2. To view the users or roles assigned to that specific App Engine subscription, click a subscription tile.
3. In the Roles related list, click a role to view the Role record.

To learn more about roles and how they relate to users and groups, see Roles.

The Custom Tables related list contains information about the custom tables that the role can access for the subscription:

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Name of the custom application that the custom table belongs to. <strong>Global</strong> appears if the custom table is for global use.</td>
</tr>
<tr>
<td>Table</td>
<td>Name of the custom table that belongs to the application.</td>
</tr>
</tbody>
</table>

4. To view the users assigned to the role, click the Subscribed Users related list.

<table>
<thead>
<tr>
<th>Subscribed users related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fields</td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>Name of the subscribed user who is assigned to the role.</td>
</tr>
<tr>
<td>State</td>
<td>Indicator of whether this role is active for the user.</td>
</tr>
<tr>
<td>Inherited</td>
<td>Indicator of whether the user has inherited this role from a parent group.</td>
</tr>
</tbody>
</table>

5. To remove users from the role, select the users in the Subscribed Users listing, and from Actions on selected rows, click Remove user's access to table.
6. When the Remove User from Role confirmation dialog appears, click OK.
7. To formally remove the user's access to the custom table, click Confirm when the final Remove User from Role confirmation dialog appears.

The selected user's access is removed from the custom table for the selected subscription. After either remediation action is complete, the subscription compliance automatically updates to reflect the change.

**Survey Management**

With the ServiceNow® Survey Management application you can create, send, and collect responses for basic surveys. If installed, you can also use the Survey widget to set up a survey within Service Portal.
Get started with Survey Management

Two versions of the application are supported, Survey Management, which is the latest version, and Legacy Surveys. Survey Management improves the user interface and extends the capabilities of the Legacy Surveys application.

Configuring surveys

There are many options for advanced configuration in Survey Management:

- Create a survey, add questions, and choose recipients, all in one interface.
- Create conditional questions, which appear only when users answer other questions a certain way.
- Restrict a survey so only specific survey users can take it, and send invitations to those users simultaneously. Alternatively, make the survey a public survey so that any user can take the survey, even anonymous users (users who have not logged in to the ServiceNow system).

**Tip:** The assessment_take2 UI page should be public for public surveys. If that page is not public, anonymous users do not have access to the page and public surveys do not work.

- Set a schedule to automatically assign a survey to users and to limit how often the same user can take a survey.
- Customize the look and feel of survey questionnaires.
- Save anonymous survey responses.
- Convert survey responses to numerical scores and view them on scorecards.
- Deactivate a survey for maintenance or to retire it without deleting it.

**Note:** Because surveys use the same tables and other back-end components as assessments, you may see assessment elements such as table and field names in certain places throughout the survey feature.

Legacy Surveys

Survey administrators can continue to use legacy survey functionality and data, however, it is recommended that you migrate legacy surveys to the Survey Management application. Concurrent use of both survey applications can cause confusion and redundancy.
Survey wizards are not impacted and cannot be migrated.

**Note:** The Legacy Surveys application is not described in the documentation that you are viewing. It is documented on the ServiceNow wiki.

### Version comparison

<table>
<thead>
<tr>
<th>Capability</th>
<th>Surveys</th>
<th>Legacy Surveys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surveys in Service Portal.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save new survey responses each time a user takes the same survey.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Create question templates to reuse sets of answer options.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Categorize survey questions and report on category results.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Deactivate a survey without deleting it.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Create conditional questions.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Send surveys automatically based on a schedule.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Customize survey questionnaire color scheme.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Save anonymous survey responses for logged-in users.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>View survey responses on graphical scorecards.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Save surveys in a draft state until they are ready to publish.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Create and send surveys from one page.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Allow only specific users to access a survey.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Send surveys based on conditions.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Send survey email notifications.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Capability</td>
<td>Surveys</td>
<td>Legacy Surveys</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------------</td>
</tr>
<tr>
<td>Limit how often a user can take the same survey.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Add introduction and end note text.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Create survey modules.</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Public survey: Allow persons to take a survey without logging in.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Use update sets to track changes.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

### Survey Management roles

The Survey Management application uses the following roles.

No role is required to take assigned survey questionnaires.

#### Survey Management roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Survey administrator       | Create and administer surveys. Survey administrators know what types of surveys are necessary, when to send a survey, and to whom. Survey administrators can use all modules in the Survey application menu. | • survey_reader  
• assessment_admin                |
| [survey_admin]             |                                                                                                                                             |                                 |
| Survey reader              | View surveys and related information, such as survey responses, survey groups, scorecards, and reports.                                                                                               | none                            |
| [survey_reader]            |                                                                                                                                             |                                 |

### Key survey terms

These survey terms are used throughout the documentation to describe survey management functions and capabilities.
### Key survey terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey definition</td>
<td>Root record on which a survey is built. A survey definition contains information such as the survey name, state, and distribution schedule. Each survey definition has its own categories and questions. Survey definitions are comparable to legacy survey masters.</td>
</tr>
<tr>
<td>Public survey</td>
<td>Any user can take a public survey, even users who have not logged in to the ServiceNow system. For a completed survey, the <strong>Assigned to</strong> field value is <strong>Guest</strong>.</td>
</tr>
<tr>
<td>Survey category</td>
<td>Represents a theme for survey questions. Categories contain one or more questions. The system creates one category per survey by default. Additional categories are optional.</td>
</tr>
<tr>
<td>Survey question</td>
<td>A question that appears on a survey questionnaire for the associated survey definition. Survey questions are comparable to legacy survey questions.</td>
</tr>
<tr>
<td>Survey user</td>
<td>User who is authorized to receive invitations for a restricted survey.</td>
</tr>
<tr>
<td>Survey instance</td>
<td>Represents one survey questionnaire assigned to one user. Survey instances are comparable to legacy survey instances.</td>
</tr>
<tr>
<td>Trigger condition</td>
<td>Defines a rule that enables the system to send a survey when an action occurs on a table, such as when an incident closes. Trigger conditions are comparable to legacy survey conditions.</td>
</tr>
<tr>
<td>Scorecard</td>
<td>Visual representation of survey responses. Scorecards display a variety of data summaries for one survey definition.</td>
</tr>
</tbody>
</table>

### Survey questionnaires

All surveys that are assigned to you appear in your personal assessment and survey queue.

No special role is required to complete a survey but you must be logged in and the survey must be assigned to you. When you submit a survey, the system stores your responses.

### Survey notification

If the system is configured to send email, it sends you a notification when a survey is assigned to you. The message contains a link to the survey and instructions for viewing the assessment and survey queue.
Take a survey

Surveys that are assigned to you, and that are not complete, appear in your assessment and survey queue.

Role required: none

Each assessment or survey appears as a card in the queue. The card contains helpful information, including the survey name, state, and due date, and a button to launch the questionnaire. Overdue surveys are clearly marked with a red icon and red due date. You must answer every mandatory question, indicated by a red asterisk, before you can submit the survey. If you start to take a survey but cannot complete it, save your responses and return to it later. When you have answered all the questions and are satisfied with the responses, submit the survey.

1. Navigate to Self-Service > My Assessments & Surveys.
   Users with the assessment_admin role, including survey administrators, can display other users’ assessments and surveys in addition to their own. Use the Show all and Show assigned to me related links at the bottom of the queue to show and hide assessments and surveys. Click a card assigned to another user to open the associated metric type or survey definition.

2. Click Take Survey on a survey card to open the questionnaire.
   If there is more than one survey category, you can click the collapse or expand icon to hide or show the questions in the category.

3. Answer each question to the best of your ability.
   If you are unsure of how to respond to a question or if a question does not apply to a particular record, select Not Applicable, if available.

4. Complete one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save your responses without submitting them</td>
<td>Click Save. You can close the questionnaire and access it later from your queue.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The system does not save the survey if there are invalid responses, such as a letter in a date field. You must enter valid responses or remove invalid responses before you can save the survey.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Submit the survey after answering all questions</th>
<th>Click Submit. You cannot return to the questionnaire after submitting.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> If there is an unanswered mandatory question or an invalid response, an error message appears and the problematic questions are temporarily highlighted.</td>
</tr>
</tbody>
</table>

Domain separation for Survey Management

This is an overview of domain separation as it pertains to Survey Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.
Overview

Support: Data onlyDomain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

As a survey creator, survey_admin can create surveys in the assigned domain. A Global domain survey_admin can create or edit survey in any domain.

As a survey taker, a user can access the survey record and take the survey based on the domain of the survey record and user. Global domain users can take a survey in any domain.

How domain separation works in Survey Management

There are several main areas to consider in how domain separation works in Survey Management.

Survey Management in domain-separated instances

The following domains are available by default after activating the Domain Support-Domain Extensions Installer [com.glide.domain.msp_extensions.installer] plugin. Only ServiceNow employees can activate this plugin.

- Global
- Acme
- Cisco

Access to surveys in domain-separated instances

Based on the domain of the survey record and users, users can access the survey record and take the survey.

Global domain users can access survey records in any domain. Users in any other domain can access records in their domain and Global domain. For example, users in the Acme domain can access records in the Acme domain and the Global domain.

Global domain users can take a survey in any domain. Users in any other domain can take surveys in their domain as well as the Global domain. For example, users in Acme domain can take surveys in the Acme domain and the Global domain.

<table>
<thead>
<tr>
<th>Location of the survey record</th>
<th>Users who can access and take the survey</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Global, Acme, Cisco</td>
</tr>
<tr>
<td>Global</td>
<td>Yes, Yes, Yes</td>
</tr>
<tr>
<td>Acme</td>
<td>Yes, Yes, No</td>
</tr>
<tr>
<td>Cisco</td>
<td>Yes, No, Yes</td>
</tr>
</tbody>
</table>

Any domain user can assign a survey in that domain to the same domain user or a Global domain user. For example, an Acme domain user can assign a survey to a Global domain user or an Acme domain user. Users from other domains are not visible to the Acme domain user.

Although the Global domain user can view a survey from other domains, this user cannot assign the survey of one domain to a user from a different domain. For example, a Global domain user can assign a survey from the Acme domain to another Global domain user or an Acme domain user, but not to a Cisco domain user.
Note: When a task is closed in a child domain and the assigned survey is either in the child domain or the global domain, the user from the child domain can then take the survey.

Trigger conditions in domain-separated instances

A Global domain user can create a triggered condition for a survey from any domain. The Global domain user can create an incident and trigger the survey by selecting a user from the other domain in the User field under Caller. However, the Global user cannot assign the survey to the user of different domain.

A user can assign a trigger condition to a survey if the user belongs to the Global domain or the Survey domain.

If there is no domain path for a trigger condition, users from any domain can view the trigger condition. For example, in the asmt_condition table that has no column for the domain path, users from the Acme domain can view the trigger condition created by the Cisco domain users.

Survey responses and results

There is a metric result record for each user response to each question on every survey instance. Survey results for each question and category are calculated automatically based on the metric result records.

If you use survey result calculations for results and scorecards, ensure that the positive indicator field for the question is set appropriately, based on the answer options. To have any results, a category must contain scored questions.

Survey responses

Survey responses are stored in the Metric Result [asmt_metric_result] table and display the recipients' answers to each question in a category. To view general results, navigate to Survey > Survey Responses. To view results for a particular criterion, use a filter on the Metric Result [asmt_metric_result] table. For example, to view results based on the assignment group, apply a filter condition for assignment group.
Survey metric results

Category results

Category results are stored in the Assessment Category Result [asmt_category_result] table and display the overall ratings for each category based on the weighted value for each scored question. To view these results, navigate to Assessments > Results > Category results and filter the results using the [Type.Evaluation method] [is] [Survey] condition.
Assessment category results

Survey scorecards

A scorecard provides a visual breakdown of survey responses, based on the way questions were answered, by category. To access a scorecard, see View a survey scorecard.

View results for all surveys

You can view the survey responses that are stored on the Metric Result [asmt_metric_result] table.

Role required: survey_admin or survey_reader

1. Navigate to **Survey > Survey Responses**.

   Do not confuse this module with **Survey > Legacy Surveys > Survey Responses**, which displays legacy survey responses.

   The **Type** column displays the survey definition each response is associated with.
2. Select a response to view its details.

**View the results for a survey**

You can view the responses for one survey definition. Survey results are stored on the Metric Result [asmt_metric_result] table.

Role required: survey_admin or survey_reader

1. Navigate to **Survey > View Surveys**
2. Open a survey definition.
3. Under **Related Links**, click **View Responses**, which is available only if there are results.
   The results are grouped by metric, which is what questions are called in assessments.
4. Open a metric result to view more detail.
   The metric result contains the user's response and calculated values of interest to advanced survey administrators. Because the Metric Result table is also used by the assessment feature, many field names are not clear in the context of surveys.

### Metric result fields

List of field descriptions for the Metric Result form.
## Metric Result form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment group</td>
<td>Assessment group to which the metric result belongs. An assessment group is a container for survey instances and results generated in a single occurrence. The system generates an assessment group every time at least one survey instance is created. If multiple survey instances are created at once, such as when a survey administrator sends invitations to a list of survey users, they are all stored in the same assessment group.</td>
</tr>
<tr>
<td>Metric</td>
<td>Question that the user answered.</td>
</tr>
<tr>
<td>Data type</td>
<td>Data type of the question the user answered.</td>
</tr>
<tr>
<td>Method</td>
<td>Assessment method. Always Assessment for surveys.</td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time the metric result was last updated.</td>
</tr>
<tr>
<td>Source</td>
<td>Survey definition from which the associated survey instance was generated.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User who completed the survey questionnaire.</td>
</tr>
<tr>
<td>Instance</td>
<td>Survey instance completed by the Assigned to user.</td>
</tr>
</tbody>
</table>
| Actual value    | Value obtained from the user response to the question. The actual value is determined by the question data type:  

- **Checkbox:** The actual value is 0 if the check box is cleared and 1 if it is selected.  
- **Choice** or **Likert Scale:** The actual value is equal to the Value of the metric definition associated with the chosen answer option.  
- **Date, Date/Time,** or **String:** The actual value is -1 to indicate that these data types do not contribute to category result calculations.  
- **Template:** The actual value is equal to the Value of the template definition associated with the chosen answer option.  
- **Yes/No:** The actual value is 0 if the response is No and 1 if it is Yes.                                                                 |
| Normalized value| Adjusted value that accounts for the Scale definition setting, minimum and maximum values, and other factors.  
The equation that generates the value and an example calculation appear in Normalized value for an assessment. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String value</td>
<td>Value that displays the response as it appears on a questionnaire. In some cases this is the same as the Actual value, such as when the question data type is Percentage. The string value is N/A for unanswered questions of certain data types.</td>
</tr>
</tbody>
</table>

**Normalized value for an assessment**

The normalized value is calculated based on a linear equation and the scale definition of the metric.

**Normalized value for any metric**

The normalized value is directly proportional to the scale definition of the metric. If the scale definition is low, that is, the lower scale values are better, then \( \text{Normalized value} = 1.0 - \text{Normalized value} \).

For reporting purpose, use the Metric Result [asmt_metric_result] table.

\[
\text{Normalized value} = \frac{(\text{Input Value} - \text{Min value defined in metric})}{(\text{Max value defined in metric} - \text{Min value defined in metric})} \times \frac{\text{(current metric weight}}{\text{(sum of valid metric weight in the metric category))}} \times \text{scale_factor}
\]

**Note:**

- If a metric is skipped when taking the assessment, its weight is excluded when calculating \( \text{sum of valid metric weight in the metric category} \).
- The following metric types are excluded in the normalized value calculation:
  - String
  - Date
  - Date/Time
  - Reference
  - Attachment
  - Ranking

For example, consider the following scenario.

Calculate the normalized value for the Please rate the competency of the technician metric.

**Values of the metric**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Input value</td>
<td>3</td>
</tr>
<tr>
<td>Minimum value</td>
<td>1</td>
</tr>
<tr>
<td>Maximum value</td>
<td>6</td>
</tr>
<tr>
<td>Current metric weight</td>
<td>10</td>
</tr>
</tbody>
</table>
Number of metrics in the metric category | 6
---|---
  • 4 of type=number
  • 1 of type=yes/no
  • 1 of type=string (invalid data type; value cannot be calculated)

Valid metric weight of each response | 10
Scale factor | 10

Normalized value = \( \frac{(3 - 1)}{(6 - 1)} \times \frac{10}{10 + 10 + 10 + 10 + 10} \) * 10 = 0.8

**View a survey scorecard**

A survey scorecard provides a visual breakdown of survey responses by category, based on the way questions were answered.

Role required: survey_admin or survey_reader

A scorecard displays charts for survey results, in which category and question responses are analyzed and current ratings are compared with previous ratings. Users can examine ratings over time, compare question ratings, or compare the ratings of all categories. All ratings are averages for the time range selected. The system dynamically updates a scorecard each time you view it, so the ratings reflect recently completed surveys.

1. Navigate to **Survey > View Surveys**.
2. Open a survey definition.
3. Under **Related Links**, click **View Scorecard**. The interactive scorecard displays the following filters:
   - Question Results: Displays the result of all questions or an individual question.
   - Category Results: Displays the results of all questions associated with an individual category or all categories.
   - Average Ratings: Displays the result of weighted average rating for each survey question in an individual category or all categories.
   - History: Displays the result of all questions in comparison with their history (by calendar year or quarters).
   - Sentiment Analysis Results: Displays the results of sentiment analysis for the survey.

*Note:* The scorecard link is hidden if there are no survey results to report.

**Survey scorecard category results**

The Category Results view is a stacked bar chart showing survey results for all questions in an individual category or all categories by respondent count.

Select a category from the list to display the questions from that category in the chart.

This view displays responses that use the following data types:

- Checkbox
- Choice
- Likert Scale
- Number
- Template
• Yes/No
• Multiple selection
• Image Scale
• Numeric Scale

**Note:** The **Checkbox** and **Yes/No** data types are combined into the **Boolean** data type in the **Survey Designer**

**Survey category results**

To view details about a specific response, point to the colored bar to display the response, the number of responses, and the percentage it represents of all the responses to that question.
Survey scorecard category results detail

Survey scorecard question results

The Question Results filter displays the result of all questions or an individual question using charts or lists. For the String, Attachment, Date, Date/time, Reference, and Ranking data types, the results are displayed in the list view. The results of all other data types are displayed in the pie chart view.

Pie chart

The pie chart shows question results for all data types other than those that are displayed in the list view. See Survey question data types.

- Checkbox.
- Boolean.
- Choice.
- Likert Scale.
- Number.
- Percentage.
- Yes/No.
- Image Scale.
- Multiple Selection.
- Template. The question result shows the aggregated net promoter score (NPS) with promoters, detractors, and passives.

**Net promoter score categories**

<table>
<thead>
<tr>
<th>Question score</th>
<th>NPS category</th>
</tr>
</thead>
<tbody>
<tr>
<td>9 or 10</td>
<td>Promoter</td>
</tr>
<tr>
<td>7 or 8</td>
<td>Passive or Neutral</td>
</tr>
<tr>
<td>0 to 6</td>
<td>Detractor</td>
</tr>
</tbody>
</table>

The result is calculated as:

- \( \%\text{Promoters} = \frac{\text{Number of promoters}}{\text{Sample size}} \)
- \( \%\text{Detractors} = \frac{\text{Number of detractors}}{\text{Sample size}} \)
- \( \%\text{Passives} = \frac{\text{Number of passives}}{\text{Sample size}} \)
- \( \text{NPS} = \%\text{Promoters} - \%\text{Detractors} \)

**Note:** The Checkbox and Yes/No data types are combined into the Boolean data type in the survey designer.
Service Desk Satisfaction Survey

Survey Scorecard

How courteous and respectful was the technician who responded? (1=poor, 6=excellent)

- 2 = 2 (14.29%)
- 3 = 2 (14.29%)
- 4 = 9 (54.29%)
- 5 = 1 (7.14%)

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Survey scorecard average ratings

The Average Ratings view displays the weighted average rating for each survey question in an individual category or all categories.

Use this view to learn how individual questions affect the overall rating for the category. Select a survey category from the choice list to display the chart for that category.
Service Desk Satisfaction Survey

Survey Scorecard

Average question rating in category: Service Desk Satisfaction Survey

- How courteous and...
- How satisfied are...
- How satisfied were...
- Please rate the t...
- Was technician ab...

Average Normalized value
To view the effect of each question’s ratings on the entire category's ratings, point to the colored bar. The pop-up box shows the percentage of the total ratings represented by each individual question’s weighted average.

---

**Average ratings detail**

**Survey scorecard history**

The History view compares the current ratings for the categories and their questions with ratings from the previous three years or four quarters.

Ratings that have declined are highlighted in red and display negative numbers. Ratings that have improved are highlighted in green with positive numbers. Arrow icons beside the values in the **Diff** column indicate the trend of the current survey against the previous survey.

Point to a category to display a line chart that shows the rating trend for that category. Click a category to view the Survey Category form containing the survey questions.
Survey scorecard trend chart

3 years

To calculate the current ratings, the system averages the ratings from the trailing twelve month (TTM) period. The Diff column shows the discrepancy between the current ratings and the previous calendar year’s ratings.
## Service Desk Satisfaction Survey

### Survey Scorecard

<table>
<thead>
<tr>
<th>Overall Rating</th>
<th>Current</th>
<th>Diff</th>
<th>2013</th>
<th>2012</th>
<th>2011</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5.40</td>
<td>0.00</td>
<td>5.40</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Service Desk Satisfaction Survey</td>
<td>5.40</td>
<td>0.00</td>
<td>5.40</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>How satisfied were you with the response time to your incident? (1=not at all, 6=completely)</td>
<td>0.00</td>
<td>-1.02</td>
<td>1.02</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>How courteous and respectful was the technician who responded? (1=poor, 6=excellent)</td>
<td>0.00</td>
<td>-1.21</td>
<td>1.21</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Please rate the technical competency of the technician serving you (1=poor, 6=excellent)</td>
<td>0.00</td>
<td>-1.02</td>
<td>1.02</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Was technician able to resolve your issue during the first call?</td>
<td>0.00</td>
<td>-1.00</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>How satisfied are you with your overall service experience? (1=not at all, 6=completely)</td>
<td>0.00</td>
<td>-1.14</td>
<td>1.14</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

### Survey scorecard history - 3 years
4 quarters

Quarterly surveys compare the average rating for each question and category in the current quarter against the average ratings from the previous four quarters. The **Diff** column shows the discrepancy between the current ratings and the previous quarter's ratings. The column labels count backward, by quarter from the current quarter. For example, if the current quarter is the 3rd quarter of 2015, then the previous quarters appear as 2nd [2015], 1st [2015], 4th [2014], and 3rd [2014]. All four of the previous quarters appear, whether or not there was any data for those quarters.
### Survey Scorecard

#### Overall Rating

<table>
<thead>
<tr>
<th></th>
<th>Current</th>
<th>Diff</th>
<th>1st</th>
<th>4th</th>
<th>3rd</th>
<th>2nd</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Desk Satisfaction Survey</td>
<td>0.00</td>
<td>-5.40</td>
<td>6.40</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

#### How satisfied were you with the response time to your incident? (1=not at all, 6=completely)

<table>
<thead>
<tr>
<th></th>
<th>Current</th>
<th>Diff</th>
<th>1st</th>
<th>4th</th>
<th>3rd</th>
<th>2nd</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.00</td>
<td>-1.02</td>
<td>1.02</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

#### How courteous and respectful was the technician who responded? (1=poor, 6=excellent)

<table>
<thead>
<tr>
<th></th>
<th>Current</th>
<th>Diff</th>
<th>1st</th>
<th>4th</th>
<th>3rd</th>
<th>2nd</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.00</td>
<td>-1.21</td>
<td>1.21</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

#### Please rate the technical competency of the technician serving you (1=poor, 6=excellent)

<table>
<thead>
<tr>
<th></th>
<th>Current</th>
<th>Diff</th>
<th>1st</th>
<th>4th</th>
<th>3rd</th>
<th>2nd</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.00</td>
<td>-1.02</td>
<td>1.02</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

#### Was technician able to resolve your issue during the first call?

<table>
<thead>
<tr>
<th></th>
<th>Current</th>
<th>Diff</th>
<th>1st</th>
<th>4th</th>
<th>3rd</th>
<th>2nd</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.00</td>
<td>-1.14</td>
<td>1.14</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

#### How satisfied are you with your overall service experience? (1=not at all, 6=completely)

<table>
<thead>
<tr>
<th></th>
<th>Current</th>
<th>Diff</th>
<th>1st</th>
<th>4th</th>
<th>3rd</th>
<th>2nd</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.00</td>
<td>-5.40</td>
<td>6.40</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

---

Survey scorecard history - 4 quarters
Export a survey scorecard as an image

You can export a scorecard as an image to use in presentations or other documents.

Role required: admin or survey_admin

1. Click the menu icon (≡) and select Save as PNG or Save as JPEG and wait for the export to complete.

2. Click Download and save the scorecard image to a storage location.
Survey administration

Survey administrators—users with the survey_admin role—create and maintain surveys and configure how they are distributed and published. Surveys on Service Portal are also supported.

Survey administration includes the following procedures.

• Create, customize, and publish surveys.
• Write and maintain survey questions.
• Define trigger conditions for when surveys are sent to users, such as when an incident closes.
• Maintain surveys and survey questions as the organization's needs change.

To set up surveys in Service Portal, you must first install Service Portal and then configure the Survey widget on the page. The base system includes the Survey widget.

Surveys in Service Portal

If Service Portal is installed, you can use the Survey widget to set up surveys, quizzes, assessments, risk assessments, and attestations in Service Portal. Surveys for users on mobile devices are fully supported in Service Portal.

To create an intuitive interface for your users, you can set up surveys in Service Portal. You must first install Service Portal and then configure the survey widget on the page. To learn more about configuring a widget, see configure widget instances.
To configure a Survey widget on a page, CTRL + right-click the widget heading and select **Instance Options**.

### Service Portal: Instance options (properties) for the Survey widget

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max records</td>
<td>Number of surveys to list on the Service Portal homepage. The user can click the <strong>View all</strong> link to view all items. Default: 5</td>
</tr>
<tr>
<td>Title of the widget</td>
<td>Text that appears in the title bar of the surveys widget. Default: <strong>My Surveys</strong></td>
</tr>
</tbody>
</table>
Each survey on the My Surveys page contains a progress bar and a description. The color in the progress bar increases as a survey is completed. In the case of a triggered record, the table title is used for the survey description.

For mobile users, the **Pagination setting for Service Portal view** survey designer property is set to one question per page by default.
One Click survey

A One Click survey has no introduction page in Service Portal. This survey does not have the Submit and Cancel buttons in the desktop and iPad view.

**Note:**
- The One Click Survey field should be selected in the survey definition.
- If the public access is enabled for a One Click survey, a user can submit the survey without having to log in.

A kiosk survey is a One Click survey with only one question of any of the following types:
- Image Scale
- Choice
- Likert Scale
- Numeric Scale
- Yes/No

When you click the answer of the kiosk survey question in Service Portal, the survey is submitted and the end note is displayed on the same page as that of the survey questions.

**Note:**
- A kiosk survey does not have any Submit or Cancel buttons.
- A kiosk survey cannot have a signature, dependent questions, or additional information.

URI parameters for One Click survey

Pass these URI parameters through the `createAssessment()` API to store their values in the `asmt_assessment_instance` table for both platform view and Service Portal view.

**URI parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_refresh_interval</td>
<td>Refresh time (in seconds) after the survey submission to create another instance. For example, <code>sysparm_refresh_interval=5</code>.</td>
</tr>
<tr>
<td>sysparm_trigger_table</td>
<td>Location that is stored as the Trigger Table field in the <code>asmt_assessment_instance</code> table. For example, <code>sysparm_trigger_table=incident</code>.</td>
</tr>
<tr>
<td>sysparm_trigger_id</td>
<td>Location sysId that is stored as the Trigger ID field in the <code>asmt_assessment_instance</code> table. For example, <code>sysparm_trigger_id=1c741bd70b2322007518478d83673af3</code>.</td>
</tr>
<tr>
<td>sysparm_kiosk</td>
<td>When set to true, both sysparm_trigger_table and sysparm_trigger_id parameters should be specified. This is a mandatory parameter for kiosk requests. For example, <code>sysparm_kiosk=true</code>.</td>
</tr>
</tbody>
</table>
View the overview of all surveys

Use this homepage to view various survey reports such as results by metric type and state.

Role required: admin or survey_admin

You can refresh, add, delete, and rearrange widgets. All reports on the Survey Overview page have demo data.

1. Navigate to Survey > Overview.
   The following reports are available:

   **Survey Overview page**

<table>
<thead>
<tr>
<th>Report</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment group Customer Satisfaction 90 day average</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Service Desk Survey 'Timely Response' 90 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Surveys by Metric Type and State</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
</tr>
<tr>
<td>Service Desk Survey 'Overall Experience' 60 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Service Desk Survey 'Tech Courteous' 90 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Service Desk Survey 'First Call Resolve' 60 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
<tr>
<td>Service Desk Survey 'Tech Competence' 60 Days</td>
<td>Metric Result [asmt_metric_result]</td>
</tr>
</tbody>
</table>

2. To view the required information, click elements within the reports.
3. To refresh, edit, or close a widget, point to the widget and select the required option.

Survey designer

Users with the survey_admin role can use the survey designer. The survey designer lets you create survey categories and questions, configure the details, and publish the survey to specific users or groups.

You can assign a survey to individual users or groups who receive all the questions from all the categories. You can also customize each question and make it dependent on the response to another question. The following describes the procedures you follow to create and publish a survey.

- Create survey categories.
- Create questions within each category.
- Configure survey details, such as introductory and closing remarks and time limit.
- Select recipients for the survey.
- Publish the survey to the selected users or groups.

**Note:** The survey designer replaces the survey creator in the Legacy Surveys application. If you are using Internet Explorer version 8 or earlier, the system redirects you to the survey creator.

Survey designer elements

The survey designer is accessible from Survey > Survey Designer.
The survey designer contains the **Controls** tab, the **Questions** tab, the **Categories** tab, a header bar, and the design canvas.

**Controls tab**

To create a question, drag the appropriate data type control from the **Controls** palette and drop it onto the designer canvas.
Controls

- Attachment
- Boolean
- Choice
- Date
- Date/Time
- Number
- Percentage
- Scale
- Numeric Scale
- ABC
- String
- Template
- Reference
- Image Scale
- Multiple Selection
- Ranking
The assessment engine provides a built-in result calculation feature that converts responses to scored question data types to a score from 0 through 10.

**Question data types**

<table>
<thead>
<tr>
<th>Data type</th>
<th>Scored</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>No</td>
<td>Question with a Manage Attachments icon that allows users to attach one or more files.</td>
</tr>
<tr>
<td>Boolean</td>
<td>Yes</td>
<td>Question with a check box or <strong>Yes</strong> and <strong>No</strong> choices for user responses.</td>
</tr>
<tr>
<td>Choice</td>
<td>Yes</td>
<td>List of predefined options. For more information, see the definition of the <strong>Choices</strong> field in <em>Create a question in the survey designer</em>.</td>
</tr>
<tr>
<td>Date</td>
<td>No</td>
<td>Date field.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>No</td>
<td>Date and time field.</td>
</tr>
<tr>
<td>Number</td>
<td>No</td>
<td>Number field with predefined minimum and maximum values. The default is 1-10.</td>
</tr>
<tr>
<td>Percentage</td>
<td>No</td>
<td>Percentage field with a prescribed range.</td>
</tr>
<tr>
<td>Scale</td>
<td>Yes</td>
<td>Predefined Likert scale. Answer options appear as radio buttons.</td>
</tr>
<tr>
<td>Numeric Scale</td>
<td>Yes</td>
<td>Selectable number scale. The default is 1-5. Answer options appear as radio buttons.</td>
</tr>
<tr>
<td>String</td>
<td>No</td>
<td>Single or multi-line text field.</td>
</tr>
<tr>
<td>Template</td>
<td>Yes</td>
<td>Choice list of templates that provide a predefined scale of options. For details, see Quiz scorecards.</td>
</tr>
<tr>
<td>Reference</td>
<td>No</td>
<td>Choice list of fields from a specified reference table. This data type does not support reference qualifiers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, a user could select a user name if you specify sys_user as the reference table.</td>
</tr>
<tr>
<td>Image Scale</td>
<td>Yes</td>
<td>Question with a choice of images that can be selected. A template can be used to apply the same images to multiple questions.</td>
</tr>
<tr>
<td>Multiple Selection</td>
<td>Yes</td>
<td>Question with multiple check boxes that can be selected.</td>
</tr>
<tr>
<td>Data type</td>
<td>Scored</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Ranking</td>
<td></td>
<td>Question with an order number to be selected for each option. One order number cannot be selected twice. This question can be mandatory and it can also be dependent on a parent question, but not vice versa.</td>
</tr>
</tbody>
</table>

**Questions tab**

This tab displays all metrics added to the question bank for surveys. Use the **Filter** field to search for questions. Each metric is displayed with its name and type.

**Categories tab**

This tab displays all metric categories added to the question bank for surveys. All metrics in the question bank are group under the corresponding metric category. Use the **Filter** field to search for categories or questions.

**Header bar**

The tabs on the header bar display views and a menu of functions. Click a tab to change the view on the canvas:

- **Design**: Add and configure the properties of categories and questions. This is the default view.
- **Configuration**: Create introductions and end notes for surveys and select a signature.
- **Availability**: Select the recipients for each category in the survey.

Point to the menu icon ( Españ) to select an option. The list of options depends on the currently open survey.

- **Save**: Save the current survey without changing its state.
- **Preview**: Display a preview of the survey as it appears to recipients.
- **Publish**: Distribute the survey to the selected recipients.
- **Save and Publish**: Save the survey to the **Draft** state and distribute the survey in one step.
- **New Survey**: Open a fresh canvas for a new survey.
- **Load Survey**: View the list of existing surveys.
- **Copy Survey**: Copy the current survey.

**Design canvas**

New surveys open in the canvas of the **Design** view. The survey **Name** field appears above first category in the canvas. A blank question field appears in the category container.
Initialize appearance of the Survey Designer canvas

Configure a survey in the survey designer

Configuration settings apply to the entire survey.
Role required: admin, survey_creator, or survey_admin
1. Navigate to Survey > View Surveys.
2. Open a survey definition in Survey Designer.
3. Select the Configuration tab and complete the Survey Designer Configuration form.

Configuration tab fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select the check box to enable the distribution of this survey to recipients.</td>
</tr>
<tr>
<td>Survey Owners</td>
<td>Owners of the survey. You can add a user with the survey_creator, survey_admin, or assessment_admin role.</td>
</tr>
<tr>
<td>Anonymize responses</td>
<td>Select the check box to collect survey responses anonymously. Recipients are not listed with survey results. When a user submits a survey, the system clears the Assigned to field for the associated survey instance. Also, survey responses for anonymous surveys do not contain Assigned to values.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of this configuration or the survey to which it is attached.</td>
</tr>
<tr>
<td>Do not show survey introduction notes</td>
<td>Check box to skip the introduction notes when a survey is launched. This functionality is applicable in both the Now Platform and Service Portal product versions.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Introduction</td>
<td>Introductory content to display on surveys. You can add a welcome message or background information about the survey.</td>
</tr>
<tr>
<td>Signature</td>
<td>Acknowledgement by a survey recipient of requirements, admonitions, or expectations related to a survey.</td>
</tr>
<tr>
<td>Return URL</td>
<td>Destination address of a web page that is presented to users after they submit a completed survey. When a return URL is configured, the End note content does not appear.</td>
</tr>
<tr>
<td>End note</td>
<td>Content that is displayed to recipients after they submit a completed survey. You can add a thank you message, follow-up instructions, or other applicable information. End notes are not displayed if a Return URL is specified.</td>
</tr>
<tr>
<td>Public Survey</td>
<td>Enables public access to the survey. No login is required to take a public survey and users or non-users can respond anonymously. For completed public surveys, the Assigned to field value is Guest.</td>
</tr>
<tr>
<td>Survey Publish URL</td>
<td>Specifies a URL of the survey that can be shared with users.</td>
</tr>
</tbody>
</table>
| Pagination setting for Service Portal view | Specify how the user will see pages on the desktop or tablet view in Service Portal.  
  - Category: Display each category on a separate page.  
  - Question: Display each question on a separate page. This happens for mobile regardless of this setting.  
  - None: All items on a single page—no pagination  
  Default: Category |
| One Click Survey      | Enables a One Click survey in Service Portal. |

Note: This field appears only when Service Portal is installed.

Note: This option can be selected if the Pagination setting for Service Portal view is set to None.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Table</td>
<td>Table whose field is used as a dynamic value for a question in a triggered survey.</td>
</tr>
<tr>
<td>Allow Sentiment Analysis</td>
<td>Enables sentiment analysis for this survey.</td>
</tr>
<tr>
<td>Duration</td>
<td>Amount of time that recipients are given to complete this survey, starting from the time that the survey is generated. The default duration is 14 days.</td>
</tr>
<tr>
<td>Outlook Actionable Message</td>
<td>Includes an embedded survey in the survey email notification. After you select this check box and save the survey, a validation is run to ensure all survey questions are supported.</td>
</tr>
</tbody>
</table>

4. Select the **Availability** tab and complete the form,

**Availability tab fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessible by</td>
<td>Defines who can access the survey. Possible values are</td>
</tr>
<tr>
<td></td>
<td>• Anyone: Accessible by anyone with the survey link.</td>
</tr>
<tr>
<td></td>
<td>• Specific users: Accessible by specified users.</td>
</tr>
<tr>
<td>Survey groups only</td>
<td>If selected, a survey is available for survey groups only.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is displayed only if the <strong>Accessible by</strong> is Specific users.</td>
</tr>
<tr>
<td>Add group users</td>
<td>Group users for whom the survey is available.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is displayed only if the <strong>Accessible by</strong> is Specific users.</td>
</tr>
<tr>
<td>Add users</td>
<td>Users for whom the survey is available.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is displayed only if the <strong>Accessible by</strong> is Specific users.</td>
</tr>
</tbody>
</table>
Survey categories

Survey categories provide a way to group questions of a similar theme for a given survey.

There must be at least one survey category per survey definition and every survey question must be associated with a category. When you create a survey, the system generates one category, which all the questions belong to.

For simple surveys, one category is usually enough. Consider creating additional categories if you want to accomplish any of the following tasks.

- Separate groups of questions into collapsible sections by category on the survey questionnaire.
- Report on category scores, which are calculated based on responses for all questions within each category.

Create a category in the survey designer

A category represents a theme for evaluating a specific element of the survey topic and contains questions pertaining to that theme.

Role required: admin or survey_admin

When you create a survey, the system creates a default category, using the name of the survey. You can use this category, modify it, and create additional categories as needed. To have any results, a category must contain scored questions.

1. Navigate to Survey > Survey Designer.
2. Enter the name of the survey in the Name field.
   The system uses this name as the name of the survey and of the first category.
3. To configure the category, click the gear icon in its title bar and complete the following steps in the Properties dialog box.
   a) Enter a new name and a description for the category.
   b) Enter text in the Details field that introduces or explains the category to recipients.
   c) Click the X icon to close the Properties dialog box and save your settings.
4. To add a new category, click the + icon in the title bar of an existing category.
   The new category appears below the category that you selected to create it. You can click the X icon in a category header to delete a category that you added in error.

Create a survey category in a survey

You can modify an existing survey to add one or more survey categories.

Role required: admin or survey_admin

Only one category is required for each survey, but you can add additional categories as needed.

1. Navigate to Survey > View Surveys.
2. Open a survey definition.
3. In the Metric Categories related list, open a category or click New.
   Each survey category is stored as a record on the Metric Category [asmt_metric_category] table with a modified view for survey use.
4. Enter the survey category name and description. The category name appears on questionnaires when either of the following is true.
   - There is more than one category for the survey.
   - There is only one category and its name is different from the survey definition name. If you create a survey using the survey creator, the category name is the same as the survey definition name.

5. Right-click the form header and click Save. The Assessment Metrics and Users related lists appear.
6. Click Update.

Create a question in the survey designer

You can create multiple questions for each category in the survey designer, but each question can only be associated with one category.

Role required: admin or survey_admin

The data type that you select for each question determines how it can be answered by survey recipients.

1. In the Design view, drag a data type icon from the Controls palette and drop it into a category container.
2. To configure the question, click the gear icon in its title bar. The Properties dialog box opens.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Concise name of the question. The system uses this value to identify the question in Assessment Metric lists and in scorecard charts.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to display as the question on surveys. Enter a clear, straightforward question that is easy to understand.</td>
</tr>
<tr>
<td>Type</td>
<td>Data type selected for this question. See the table in Controls for the available data types.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this question is available on a survey. A question does not appear on surveys that are generated after the question becomes inactive.</td>
</tr>
</tbody>
</table>
| Mandatory | Check box to require users to answer the question. Mandatory questions are denoted by a red field status indicator and must be answered before the survey can be submitted.  
This field is available when the question does not have a dependency and the question type is not Boolean with a check box option. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Additional Information</td>
<td>If selected, the Additional Information Label field is enabled. The Additional Information Label field value is displayed as a field on the survey response page to provide additional information for a question.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This is not applicable for the String and Template data types.</td>
</tr>
<tr>
<td>Boolean option</td>
<td>Whether a check box or a Yes/No list appears as the option for a Boolean question.</td>
</tr>
<tr>
<td>String option</td>
<td>Setting for the appearance of a string field in a question. This field is available when the question type is String. The string options include the following.</td>
</tr>
<tr>
<td></td>
<td>• Single line: Single-line text field 40 characters in length that allows strings of any length.</td>
</tr>
<tr>
<td></td>
<td>• String line wide: Full page width text field that allows a single-line entry of any length.</td>
</tr>
<tr>
<td></td>
<td>• Multiline: Full page width multiline text field that allows word wrap and returns</td>
</tr>
<tr>
<td>Min</td>
<td>Lowest positive whole number that users can enter or select to answer the question. This field is available when the question type is Number, Percentage, or Numeric Scale.</td>
</tr>
<tr>
<td>Max</td>
<td>Highest positive whole number that users can enter or select to answer the question. This field is available when the question type is Number, Percentage, or Numeric Scale.</td>
</tr>
<tr>
<td>Allow not applicable</td>
<td>Check box for including Not Applicable as an option for this question. Users can select Not Applicable if they do not have sufficient information to respond to a question. User responses of Not Applicable are excluded from results calculations.</td>
</tr>
<tr>
<td></td>
<td>This field is available when the question does not have a dependency and the question type is not Boolean with a check box option.</td>
</tr>
<tr>
<td>Randomize answers</td>
<td>Check box for displaying answer options in a random order. Answer preference is sometimes influenced by the order in which options appear, which can result in biased results. Randomizing options can help prevent this bias.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Randomizing options for certain questions may make those questions confusing for users. In general, only randomize options that do not follow a logical order.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Positive indicator</td>
<td>Setting that determines whether smaller or larger numerical values equate to a good score in result calculations. Select <strong>Low values</strong> if smaller numerical values are better, such as for a question that measures the number of incidents for a vendor. Select <strong>High values</strong> if larger numerical values are better, such as for a question that measures user satisfaction on a scale of one to five.</td>
</tr>
<tr>
<td>Source Field</td>
<td>Source table field that appears as a dynamic value for the question in a triggered survey. When this field value is selected, a ${param} placeholder is added at the end of the question label.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can move this placeholder anywhere in the question label.</td>
</tr>
<tr>
<td></td>
<td>When a user takes the survey, the question with dynamic value is included in the survey instance and ${param} placeholder is replaced with the source field value.</td>
</tr>
<tr>
<td></td>
<td>If the record table specified in the trigger condition does not match the source table specified for the survey, or if the system fails to get the dynamic value from the source record, the ${param} placeholder is not replaced by any value and is displayed as is in the question.</td>
</tr>
<tr>
<td></td>
<td>For example, if the survey is triggered from a PRB record and the survey question is configured with a dynamic value from Incident, the $\text{${param}$}$ placeholder in the survey question label is not replaced by any dynamic value and is displayed as is.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When survey questions are translated to other languages by a survey admin, the $\text{${param}$}$ placeholder should not be translated.</td>
</tr>
<tr>
<td>Allow Sentiment Analysis</td>
<td>Includes this question for the sentiment analysis of a survey.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available only for String type questions.</td>
</tr>
<tr>
<td>Details</td>
<td>Information about the question that is displayed on the survey. Include details that help users understand how to answer the question.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Choices</td>
<td>Options for a question with a data type of <strong>Choice</strong> or <strong>Scale</strong>. The system automatically adds text and values that you can edit for each option. You must have at least two options, and each option must have a unique value. Click the + icon to add an option, or click the X icon to delete an option. By default, the system arranges options in the order established by their values. To change the order, drag and drop the options.</td>
</tr>
</tbody>
</table>

**Note:** Value numbers also contribute to the calculations of survey response scores, which can be used by advanced survey administrators.

4. To create any special conditions that must be met before the question appears on the survey, click the Dependency tab. The question must have a data type of **Boolean**, **Choice**, **Scale**, or **Template**.

5. Select a question in the **Displayed when** field. The system selects the appropriate operator and displays the possible answers for the selected question.

6. Select the answer that satisfies the condition. You can select more than one answer. Selected answers are indicated by a check mark. The system prevents recursive dependencies between questions. For example, if Question A depends on Question B, Question B cannot depend on Question A.

7. Click the X icon to close the question properties dialog box and save your settings.

8. To add a question with the same data type as an existing question in the category, click the + icon in the title bar of the existing question.

9. Drag and drop questions to change their order within a category or move them between categories.

10. To delete a question, click the X icon in its title bar.

**Survey question data types**

You must choose a data type for each survey question. The data type determines the format of the question and the kind of data that is collected on survey questionnaires.

The following data types are available for surveys:
Attachment data type

On questionnaires, users can attach one or more files to a question.

Users click the Manage Attachments icon and select one or more files in the Attachments pop-up window to attach to the question. From this window, users can:

- View a list of the attached files.
- View an attached file in a separate window.
- Rename an attached file.
- Add or delete files

Once a survey has been submitted, attachments cannot be updated or deleted.

Any type of file supported by the platform can be attached to a question. One or more files can be attached a question while taking a survey or completing an assessment.

The assessment administrator can see the attachments associated with an individual question as well as those associated with the survey.

See Administering Attachments for more information.

Boolean data type

On questionnaires, users select a check box beside a statement or leave it cleared.

- I am interested in receiving more information about this topic.

If you select Boolean, you must fill in the Scale definition field. Select High if it is best when users select the check box.

Choice data type

On questionnaires, users select a value from a list of choices.

If you select Choice, you must fill in the Scale definition field and create answer options. Select High for the scale definition if the answer option with the largest metric definition Value is best.
**Note:** The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.

### Date and Date/Time data types

The **Date** and **Date/Time** data types are similar.

- **Date:** On questionnaires, users select a date.
• **Date/Time:** On questionnaires, users select a date and time.

[Image of a date and time selection interface]

**Likert Scale data type**

On questionnaires, users select a multiple choice value from a custom Likert scale. Each answer option is represented by a radio button on the scale. A Likert scale question that evaluates an application's ease of use might have the answer options **Easy**, **Average**, and **Difficult**.

[Image of a Likert scale with options]

If you select **Likert Scale**, you must fill in the **Scale definition** field and create answer options. Select **High** for the scale definition if the answer option with the largest metric definition **Value** is best.

**Note:** The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.

**Number data type**

On questionnaires, users enter a number.
If you select **Number**, you must fill in these additional fields:

- **Scale definition**: Select *High* if a larger number is better, such as for a question that measures the number of sales made in a quarter.
- **Min and Max**: Enter the smallest and largest numbers users can enter. State the range of acceptable answers in the question text.

**Percentage data type**

On questionnaires, users enter a number.

If you select **Percentage**, you must fill in these additional fields:

- **Scale definition**: Select *High* if a larger percentage is better, such as for a question that measures the percentage of work an agent has completed.
- **Min and Max**: Enter the smallest and largest numbers users can enter. Generally, 0 and 100 are appropriate minimum and maximum values. If you choose values other than 0 and 100, it is usually best to state the range of acceptable answers in the question text.

**Reference data type**

On questionnaires, users select a value from a list that is generated from a specified reference table. The response field supports auto-completion.

**Note**: Reference qualifiers are not supported.

For example, a user could select a user name in response to a question if you specify User [sys_user] as the reference table.
String data type

On questionnaires, users enter text. When you select String, the String option field appears. Select one of the following options to determine how the string field appears on questionnaires:

- Single line
**Template data type**

On questionnaires, users select a value from a predefined series of answer options. To use this data type, a question template must be defined.

If you select **Template**, you must fill in these additional fields:

- **Template**: Select a template.
- **Scale definition**: Select **High** if the answer option with the largest template definition **Value** is best.

**Yes/No data type**

On questionnaires, users select **Yes** or **No** from a list.

If you select **Yes/No**, you must fill in the **Scale definition** field. Select **High** if **Yes** is the best answer.
Image Scale data type

On questionnaires, users select an image from a predefined set of images as their response. Image scale questions can also be used in a template for better performance with surveys that have the same type of answer options.

Five emojis, similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Two images can be uploaded, one for selected case and another for unselected case. Larger size images are reduced to 64 x 64 pixels.

The result behavior depends on the presence of uploaded images. If no selected image is uploaded, then the question shows up blank.

<table>
<thead>
<tr>
<th>Selected image</th>
<th>Unselected image</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Unselected image loads. Clicking on the image changes it to the selected image.</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>Selected image loads with 50% opacity. Clicking on the image changes the opacity to 100%.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>A blank placeholder box is displayed.</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>A blank placeholder box is displayed.</td>
</tr>
</tbody>
</table>

Note: N/A option is not supported for image scale type question.

Multiple selection data type

On questionnaires, users can select multiple check boxes indicating all answers that apply. For instance, a user can be instructed to "Select all that apply" in a multiple selection question.
Equipment Usage Survey

Multiple Selection

What equipments do you use?

- Laptop
- Tablet
- Smart Phone

Ranking data type

On questionnaires, users can select a different order number for each option to rank them. Drag-and-drop functionality is also supported, which allows a user to either fill in the number, or simply drag an option.

One order number cannot be selected twice. This question can be mandatory and it can also be dependent on a parent question, but not vice versa.

Edit a survey in the survey designer

You can modify surveys using the survey designer.

Role required: admin or survey_admin
You can edit a survey even after it has been distributed, with the following results.

- Added questions are available only on surveys that are distributed after this change.
- Changes to existing questions are immediately available to users before the survey is submitted or during the retake period. This includes changes to the answers, such as additional choices or changes to the data type.
- Deleted questions are also deleted from the distributed surveys in user queues.

**Note:** You can only edit a survey that has the same application scope as that of your current session.

1. Navigate to **Survey > Survey Designer**.
2. Point to the menu icon in the survey header bar, and select **Load Survey**.
3. Select a survey from the list and modify it as needed.
4. Point to the menu icon in the survey header bar, and select **Save** or **Save and Publish**.
   When you publish the edited survey, the system generates survey instances for any associated survey users.

**Configure category weights for a survey**

You can assign a weight to each category in a survey. The system calculates results from the weight that you configure.

Configure the Survey Category form to display the **Weight** field.

Role required: admin or survey_admin

Weights are set to a value of 10 by default but can be changed.

1. Navigate to **Survey > View Surveys** and select a survey from the list.
2. In the Survey Definition form, select a category from the **Metric Categories** related list.
3. Edit the default weight value.
4. Click **Update**.

**View a survey instance**

A survey instance represents one questionnaire assigned to one user. You view an instance to verify that survey instances were created, to check the state of a survey instance, or to reassign a survey instance.

Role required: admin or survey_admin

1. Navigate to **Survey > Survey Instances**. The following sub-modules are available based on the state of the instances:
   - **Ready to take**: Displays survey instances that are ready to be taken by the user. By default, these instances are sorted in ascending order by the **Number** field.
   - **In progress**: Displays survey instances that are in progress. By default, these instances are sorted in ascending order by the **Number** field.
   - **Completed**: Displays survey instances that are complete. By default, these instances are sorted in descending order by the **Taken on** field.
   - **Cancelled**: Displays survey instances that are cancelled. By default, these instances are sorted in ascending order by the **Number** field.
   - **All**: Displays survey instances in all states. By default, these instances are sorted in ascending order by the **Number** field.
2. Open a survey instance from the required sub-module. By default, the following fields are displayed in the Survey Instance form for all sub-modules other than **Completed**.

### Note:
- When you open an instance in the **Completed** sub-module, you are redirected to the User's Response page.
- Each survey instance is stored as a record on the Assessment Instance [asmt_assessment_instance] table with a modified view for survey use.

#### Survey Instance form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated record number.</td>
</tr>
<tr>
<td>Metric type</td>
<td>Survey definition this survey instance was created from. Survey definitions are stored on the Assessment Instance table, and the field label on that table is <strong>Metric type</strong>.</td>
</tr>
<tr>
<td>Due date</td>
<td>Date by which the survey instance should be completed. The system populates the due date based on the <strong>Assessment duration</strong> of the associated survey definition, which is set to 14 days by default. The survey due date is not enforced in the base system. If you want to enforce the due date, consider using a workflow or other mechanism to send survey recipients reminders when a survey is overdue. <strong>Note:</strong> By default, the system runs the <strong>Cancel Expired Assessments</strong> script every 30 days to cancel expired survey, assessment, and quiz instances that are in the Work in progress or Ready to take states.</td>
</tr>
<tr>
<td>State</td>
<td>State of the survey instance.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User this survey instance is assigned to. This field becomes read-only when the state is In progress, Complete, or Canceled.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain associated with the instance.</td>
</tr>
<tr>
<td>Expiration date</td>
<td>Date on which the assigned user can receive a new instance of the same survey definition. The system automatically populates the expiration date based on the <strong>Schedule period</strong> of the associated survey definition.</td>
</tr>
<tr>
<td>Related Link</td>
<td></td>
</tr>
<tr>
<td>View User’s Response</td>
<td>Shows a read-only version of the survey responses completed by the user.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry Sentiment Analysis</td>
<td>Sends the survey instances for sentiment analysis.</td>
</tr>
<tr>
<td><img src="image" alt="Note: This link is available only if any sentiment analysis result is not available for this instance under Survey &gt; Question Sentiment Results" /></td>
<td></td>
</tr>
</tbody>
</table>

### Related List

<table>
<thead>
<tr>
<th>Assessment Instance Questions</th>
<th>All instance question records, which store user response values for each question on the survey questionnaire. The following columns are relevant to surveys:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Displays the survey categories the questions belong to.</td>
</tr>
<tr>
<td>Metric</td>
<td>Displays the survey questions.</td>
</tr>
</tbody>
</table>

---

**Survey users and groups**

Survey users and survey user groups help survey administrators control who can take a survey.

Survey administrators can restrict a survey so that only specified users can access it unless a survey administrator manually assigns the survey to a different user. Survey user groups provide a way to quickly designate multiple survey users.

**Administering survey users**

The list of survey users for a survey is visible on the Survey Definition and Survey Category forms. You can add or remove users from the list of survey users at any point. Note that designating a survey user does not automatically generate a survey instance for that user unless both of the following conditions are true:

- The survey definition **Schedule** period is set to **Daily**, **Weekly**, **Monthly**, or **Yearly**. In this case the system assigns a new survey instance to each survey user at the beginning of each schedule period.
- The user has no instances of the survey that are incomplete or that have not yet reached their expiration date.

You can designate survey users from the Survey Designer, the Survey Definition form, or the Survey Category form.

![Note: If there are trigger conditions for a survey, do not create survey users. Instead, use the Trigger Conditions form to assign users.](image)

**Create a survey user group**

Survey user groups are groups that have the **Type** field set to survey and display only the information most relevant to surveys. You can assign survey groups or any user group to surveys.

**Role required:** admin or user_admin

Though it is possible to designate members of any group as survey users, one reason to create a survey group is to view it conveniently in the survey **User Groups** module.
By default, the Survey Creators user group is available. When you add a user to this group, the user will be assigned the survey_creator role to create surveys, quizzes, or assessments and view only those surveys, quizzes, or assignments created by the user.

1. Navigate to **Survey > Administration > User Groups**.
2. Click **New**.
3. Complete the Group form.
4. Right-click the form header and click **Save**.
   The Group Members and Groups related lists appear.
5. To add group members, complete the following steps.
   a) In the Group Members related list, click **Edit**.
   b) Select users from the list on the left and add them to the Group Members List on the right.
   c) Click **Save**.

**Select recipients for a survey in the Survey Designer**

You can assign survey users while designing or modifying the survey.

Role required: admin or survey_admin

1. In the Survey Designer, click the Availability tab.
2. Under Accessible by:, select the Specific users option, then select users.
3. If desired, select the Survey groups only check box, then select survey user groups or other groups.
4. Click **Save**.

**Designate a survey user**

You can designate one survey user at a time from the Survey Definition form.

Role required: admin or survey_admin

1. Navigate to **Survey > View Surveys**.
2. Open a survey definition.
   There must be at least one category.
3. In the Survey Users related list, click **New**.
4. Select a User.
5. Click **Submit**.
   The Survey Definition form reopens.
6. Optional: To remove survey users, in the Survey Users related list, select the check box beside the user, and then select **Delete** from the action list below the list.

**Designate or remove multiple survey users at one time**

Use the Survey Category form to designate or remove multiple survey users at one time.

Role required: admin or survey_admin

1. Open a survey definition.
2. In the Metric Categories related list, open a category.
   You can choose any category. The system applies survey user changes to all the survey's categories automatically.
3. In the Users related list, click **Edit**.
4. Use the slushbucket to add or remove survey users.
5. Click Save to return to the survey category.
   The changes are also reflected in the Survey Users related list on the survey definition.

**Allow recipients to retake a survey**

You can configure a survey to allow recipients to resubmit their answers as many times as they like, up to the survey's due date.

Configure the Survey Definition form to display the Allow retake field. For more information, see Configure the form.

Role required: admin or survey_admin

Results are not calculated for the survey until the configured duration has elapsed. The card in the user's queue remains visible until the due date of the survey, and a button is displayed to allow retakes.

1. Navigate to Surveys > View Surveys.
2. Select a survey from the list.
3. Select the Allow retake check box.
4. Click Update.

**Copy a survey**

Create a copy of a survey with at least one category to reduce the effort of creating another survey with similar data.

Role required: survey_admin or admin

All associated questions (type), configurations, categories, metrics, domain separation rules, and role-based categories are copied. Assigned users, category users, instances, and trigger conditions are not copied.

1. Navigate to Survey > View Surveys.
2. Open a survey definition.
3. Perform any of the following steps:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Platform</td>
<td>In the title bar, click Copy.</td>
</tr>
<tr>
<td>From Platform</td>
<td>In the title bar, select Copy from the context menu.</td>
</tr>
<tr>
<td>From survey designer</td>
<td>a. In the title bar, click Survey Designer.</td>
</tr>
<tr>
<td></td>
<td>b. In the Survey Designer title bar, point to the menu icon ( ) on the header bar and click Copy Survey</td>
</tr>
</tbody>
</table>

**Publish a survey**

You must publish a survey to enable people to receive and complete survey instances.

Role required: admin or survey_admin

The State field on the Survey Definition form indicates whether the survey is in the Draft or Published state.
Publish a survey in the Survey Designer

You must save changes to a survey before you can publish it to the specified recipients or groups.

Role required: admin or survey_admin

1. In the Survey Designer, point to the menu and select Load Survey.
2. Select a survey to publish.
3. To preview the survey as a user, point to the menu icon and click Preview.
4. When you are satisfied with the survey, click either Save and Publish or Publish to distribute it.

When you publish a survey, the system sends email notifications to the recipients and to their managers. The system displays a link to the survey on a card in each recipient's My Assessments & Surveys portal.

Customize the appearance of a survey

Assessment and survey administrators can set properties to customize the color of various elements on the questionnaires.

Role required: admin or survey_admin

For color properties, enter either an HTML color name or hexadecimal (hex) value. For hex values, the # character is required. Values are not case-sensitive.

For example, all of the following formats are valid: LightGray, lightgray, #D3D3D3. A preview of the color appears next to the field.

Note that the customizations you make apply to all assessments and surveys.

1. Navigate to either of the following modules.
   - Assessments > Admin > Assessment Properties
   - Survey > Administration > Properties
2. On the properties page, edit the properties as needed. Refer to the screenshot below to see what parts of assessment questionnaires are controlled by the properties.

3. Click Save. You may need to clear the browser’s cache to see updates.

Assessment and survey properties

You can configure a variety of properties to customize the appearance of assessment and survey questionnaires, require authentication for user signatures, open surveys in the service portal view from emails, and limit the number of items shown in a decision matrix field filter.

Assessment and survey properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_portal_surveys.sp_survey.email_redirection</td>
<td>Allow survey link from email to open in service portal view (applies only for surveys)</td>
<td>When Yes is selected, a survey accessed from a link in an email opens in the Service Portal.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This property applies only to surveys.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: No</td>
</tr>
<tr>
<td>com.snc.assessment.signature_authentication</td>
<td>Require authentication for user signature.</td>
<td>When Yes is selected, this property requires credentials for a full name signature.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: Yes</td>
</tr>
</tbody>
</table>
Survey definitions

A survey definition is the root record upon which a survey is built.

The survey designer generates a survey definition automatically when you save or publish the survey. Survey administrators may want to modify the survey definition to configure additional options for the survey, or to publish the survey when it is ready for distribution.

Survey administrators and survey readers can also send survey invitations directly to users from the survey definition.

Modify a survey definition

You can configure additional options for a survey definition.

Role required: admin, survey_creator, or survey_admin

1. Navigate to Survey > View Surveys.
   Each survey definition is stored as a record on the Assessment Metric Type [asmt_metric_type] table with a modified view for survey use.
2. Open a survey definition. The Response Trend chart with the weekly trend of the survey instance count, and the Survey Summary chart with the overall summary response based on instance states are displayed.
3. Modify the fields on the Survey Definition form.

   **Note:** You can only edit a survey that has the same application scope as that of your current session.

Survey Definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the survey which appears on the questionnaire.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Helpful information about the survey.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the survey definition. When the <strong>Active</strong> check box is cleared, new survey instances cannot be generated and users cannot complete existing survey instances. Use the <strong>Active</strong> check box to deactivate or activate a published survey.</td>
</tr>
<tr>
<td>Owners</td>
<td>Owners of the survey. You can add a user with the survey_creator, survey_admin, or assessment_admin role.</td>
</tr>
</tbody>
</table>
| Anonymize responses | Check box to ensure that all responses for this survey are stored without the submitting user names. When a user submits a survey, the system clears the **Assigned to** field for the associated survey instance. Also, survey responses for anonymous surveys do not contain **Assigned to** values.  
**Note:** The **Assigned to** field is cleared. However, each response record includes the **Created By** and **Updated By** fields that are accessible to users with the survey_admin role. |
| Send notifications | Check box to send a notification that the survey has been taken.                                                                                                                                                                                                                                                                              |
| State            | Status of the survey: **Draft** or **Published**.                                                                                                                                                                                                                                                                                             |
| Allow retake     | Check box that allows users to modify their answers to a completed survey. Users can resubmit a survey as many times as they want until the due date. After that date, the system removes the survey from the user's My Assessments & Surveys page.                                                                                                                                     |
| Scheduled job    | Scheduled job that the system creates for this survey definition when the schedule period is a repeating interval. The system sets the scheduled job to run according to the selected schedule period. If you change the schedule period and save the survey definition:  
• The system deletes the old scheduled job.  
If you selected a recurring schedule period:  
• A new scheduled job is created.  
For example, if you change the schedule period from **Daily** to **Weekly** and save the record:  
• The system deletes the daily scheduled job.  
• Creates a weekly one set to run a week from the current date.  
This field is visible to administrators only if the schedule period is **Daily**, **Weekly**, **Monthly**, or **Yearly**.                                                                                   |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment duration</td>
<td>The length of time to complete assigned survey instances, starting from the time the survey instance is generated. The assessment duration sets the Due date for each survey instance. The default duration is 14 days. Configure the form to view this field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> By default, the system runs the <em>Cancel Expired Assessments</em> script every 30 days to cancel expired survey, assessment, and quiz instances that are in the Work in progress or Ready to take states.</td>
</tr>
<tr>
<td>Send notifications</td>
<td>Send notifications for the survey when it is published. Configure the form to see the field.</td>
</tr>
<tr>
<td>Other Options</td>
<td></td>
</tr>
<tr>
<td>Sample Metric</td>
<td>A metric of the current survey that you can include as an image in the email or invitation sent to a survey user. When the survey user clicks the image in the email or while previewing the HTML body, the entire survey is available to be taken.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot edit or delete a metric that is selected in this field.</td>
</tr>
<tr>
<td>Signature</td>
<td>Acknowledgement by a survey recipient of requirements, admonitions, or policies related to the survey. The signature may require the recipient to select a check box or to type in a full signature to verify having read these assertions. You can display assertions without requiring a signature. Select an existing signature from the list or click New to create a new one. The signature form contains these fields:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Name:</strong> Descriptive name for this signature.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Signature type:</strong> Type of signature required. The selections are Check box, Full name, or Assertion only. If Assertion only is selected, no signature is required to submit the survey.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Assertion:</strong> Text you want to display to recipients.</td>
</tr>
<tr>
<td></td>
<td>By default, a property called <em>Require authentication for user signature</em> (com.snc.assessment.signature_authentication) requires users to authenticate when providing a full name signature.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Schedule period</td>
<td>Option that determines how often a user can take the same survey and whether the system generates survey instances on a schedule.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you use a trigger condition for a survey, ensure the schedule period is set to <strong>No Limit</strong>. Trigger conditions use a different method to regulate how often users can receive survey instances.</td>
</tr>
<tr>
<td>Do not show survey introduction notes</td>
<td>Check box to skip the introduction notes when a survey is launched. This functionality is applicable in both the Now Platform and Service Portal product versions.</td>
</tr>
<tr>
<td>Pagination setting for Service Portal view</td>
<td>The setting on which the pagination is based for desktop or tablet view in Service Portal.</td>
</tr>
<tr>
<td></td>
<td>• Category: default</td>
</tr>
<tr>
<td></td>
<td>• Question: 1 question per page (automatic for mobile)</td>
</tr>
<tr>
<td></td>
<td>• None: no pagination</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is displayed only when Service Portal is installed.</td>
</tr>
<tr>
<td>One Click Survey</td>
<td>Enables a One Click survey in Service Portal.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This option can be selected if the <strong>Pagination setting for Service Portal view</strong> is set to <strong>None</strong>.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Table whose field is used as a dynamic value for a question in a triggered survey.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>When you select a source table, ensure that its relevant field is selected as <strong>Source Field</strong> value of a metric.</td>
</tr>
<tr>
<td>Outlook Actionable Message</td>
<td>Includes an embedded survey in the survey email notification. After you select this check box and save the survey, a validation is run to ensure all survey questions are supported.</td>
</tr>
<tr>
<td>Allow Sentiment Analysis</td>
<td>Enables sentiment analysis for this survey.</td>
</tr>
<tr>
<td>Introduction &amp; End Notes</td>
<td>Introductory content to display on survey questionnaires. Consider adding a company logo, a welcome message, background information about the survey, or instructions.</td>
</tr>
<tr>
<td>Introduction</td>
<td>End note that appears when someone submits a survey questionnaire. Consider adding a thank you message, follow-up instructions, or other applicable information.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable Public Access</td>
<td>Link that enables/disables the survey as a public survey. No login is required to take a public survey (including a survey with a trigger condition) and users or non-users can respond anonymously. For completed public surveys, the <strong>Assigned to</strong> field value is Guest.</td>
</tr>
<tr>
<td>Remove Public Access</td>
<td></td>
</tr>
<tr>
<td>View Responses</td>
<td>Link that opens the list of responses for this survey. This related link is available only if there are results for the survey.</td>
</tr>
<tr>
<td>View Scorecard</td>
<td>Link that opens the scorecard for this survey. This related link is available only if there are results for the survey.</td>
</tr>
<tr>
<td>View Survey URL</td>
<td>Link that opens a dialog box that displays a URL for this survey. The URL is useful for sharing a public survey. This related link is available only if the <strong>Active</strong> check box is selected. The URL does not work until the survey definition is published.</td>
</tr>
<tr>
<td>Show Benchmarks</td>
<td>Opens the Benchmarks Dashboard that provides visibility into your key performance indicators (KPIs) and trends.</td>
</tr>
</tbody>
</table>

**Note:**
- You can use the View Survey URL related link to share the URL with users.
- This related link is available only for survey_admin, assessment_admin and survey_reader with bm_viewer role.
- You must opt in to Benchmarks to view the dashboard. See Enable Benchmarks
- This is applicable only for a published survey.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Improvement Initiative</td>
<td>Opens the Improvement Initiative window to create an improvement initiative record that helps in improving the performance of the survey.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• This related link is available only for the survey_admin and assessment_admin role. A survey_reader can only view the created improvement initiative records.</td>
</tr>
<tr>
<td></td>
<td>• You should activate the Continual Improvement Management plugin (com.sn_cim).</td>
</tr>
<tr>
<td>Retry Sentiment Analysis</td>
<td>Checks all survey instances of this survey that do not have sentiment analysis data and sends them for analysis.</td>
</tr>
<tr>
<td>Related Lists</td>
<td></td>
</tr>
<tr>
<td>Trigger Condition</td>
<td>Displays all the trigger conditions associated with the survey.</td>
</tr>
<tr>
<td>Survey Responses</td>
<td>Displays all the responses associated with the survey.</td>
</tr>
<tr>
<td>Metric Categories</td>
<td>All survey categories for this survey.</td>
</tr>
<tr>
<td>Survey Users</td>
<td>All survey users who are authorized to take this survey. If no users are listed, any user can take this survey.</td>
</tr>
<tr>
<td>Assessment Instances</td>
<td>All survey instances for this survey. Configure the form to add this related list to see it.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you add a related list to the form, use list control to omit the New button. The system generates survey instances to produce functional surveys.</td>
</tr>
<tr>
<td>Improvement Initiatives</td>
<td>Displays improvement initiatives associated with the survey.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This related list is available only when there is at least one improvement initiative record.</td>
</tr>
<tr>
<td>Survey Recipients Lists</td>
<td>Recipients lists that are added to the survey.</td>
</tr>
</tbody>
</table>

4. Save the record.

**Schedule periods**

The available schedule periods are **Only Once, No Limit, Daily, Weekly, Monthly**, and **Yearly**.
The default schedule period is **No Limit**. When you set the schedule period to anything except **Only Once** or **No Limit**, the system creates a corresponding scheduled job. The scheduled job performs the following actions.

- Ensures that a user can take one survey instance of the same survey per schedule period.
- Generates a new survey instance for each survey user at the beginning of the new schedule period, as long as the survey user does not have an incomplete instance of that survey. A survey instance is incomplete if the state is not **Complete**.

For example, if you set the schedule period to **Monthly** and someone attempts to send survey invitations twice in the same day, the system generates survey instances for the survey users the first time only. At the beginning of the next schedule period, the system generates another survey instance for each survey user who completed the previous one.

Schedule periods are enforced by the **Expiration date** field on the survey instance. As long as the survey instance expiration date has not passed, the assigned user cannot receive a new survey instance. When the system generates a survey instance and the schedule period is anything except **No Limit**, the **Expiration date** field is automatically set to the appropriate date. For example, if the schedule period is **Weekly**, the expiration date is a week after the survey instance is generated.

If you change the schedule period, the scheduled job updates automatically to the correct schedule. However, users who have survey instances for the survey cannot receive new survey instances until their existing survey instances expire, regardless of the new schedule period.

Consider the following example: Sal Pindell receives a survey instance when the schedule period is **Weekly**. The next day, a survey administrator changes the schedule period to **No Limit**. Sal cannot receive another survey instance until one of the following actions occurs.

- Seven days pass from the time Sal's survey instance was generated.
- A survey administrator deletes Sal's survey instance.

After one of these actions occurs, Sal can receive a new survey instance anytime, as long as he has no incomplete instances of the survey.

**Note:** If you use a trigger condition for a survey, ensure the schedule period is set to **No Limit**. Trigger conditions use a different method to regulate how often users can receive survey instances.

### Create a survey designer template question

You can create a question that uses choice lists from a template.

**Role required:** admin or survey_admin

1. Navigate to **Survey > Survey Designer** and load a survey or create a new survey.
2. Drag the **Template** data type icon into a category container.
3. Click the gear icon in the question title bar to open the template properties dialog box.
4. Select a predefined scale from the list.

Question entry fields appear for that template.
5. Enter one or more questions that are appropriate for the template.
6. Click the arrow to the right of a question to configure its properties. You must provide a name for each question.

7. Click the back arrow to return to the template properties dialog box.
8. Configure the properties for the remaining questions.
9. Click the X icon to close the template properties dialog box and save your settings.

Survey questions

Survey questions appear on survey questionnaires for the associated survey definition. Survey questions are available from Survey > Questions. The list displays information about each question, including the associated survey definition listed in the Type column, and the data type. Survey administrators can modify these questions.
Create or modify survey questions

You can create and administer survey questions.

Role required: admin or survey_admin

Changes to a survey, such as the addition of questions or the modification of question templates, do not apply immediately to the existing survey instances. However, the changes apply immediately to any new survey instances that are created after the changes are saved.

1. Navigate to Survey > View Surveys.
2. Open a survey definition.
3. In the Metric Categories related list, open a category.
4. In the Assessment Metrics related list, open an existing question or click New.

Each survey question is stored as a record on the Assessment Metric [asmt_metric] table with a modified view for survey use.

5. Complete the Survey Question form.

The fields that appear depend on the selected Data type.

Survey Question form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the question. When you create a survey, the question name is the same as the text in the Question field.</td>
</tr>
<tr>
<td>Question</td>
<td>Text to use for the question, which appears on survey questionnaires.</td>
</tr>
<tr>
<td>Data type</td>
<td>Data type of the question. The fields for the response depend on the data type.</td>
</tr>
</tbody>
</table>

<i>Note: If another question depends on this question, you cannot change the data type.</i>

| Template      | Question template to use for the answer options. This field is visible and required only if the data type is Template.                      |

<i>Note: If another question depends on this question, you cannot change the template.</i>

<p>| Scale definition | Setting that determines whether smaller or larger numerical values equate to a good score in result calculations. Select Low if smaller numerical values are better, such as for a question that measures the number of incidents for a vendor. Select High if larger numerical values are better, such as for a question that measures user satisfaction on a scale of one to five. This field is visible and required only when certain data types are selected. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Randomize answers</td>
<td>Check box that determines whether to present the answer options for this question in a random order each time a user opens the survey. Answer preference is sometimes influenced by the order in which answer options appear, which can result in biased results. Randomize answer options to help prevent this bias. This field is visible only if the data type is <strong>Choice</strong> or <strong>Likert Scale</strong>. <strong>Note:</strong> Randomizing answer options may make a question confusing. In general, only randomize answer options that do not follow a logical order.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Check box that makes the question mandatory (selected) or optional (cleared) on survey questionnaires. Users cannot submit questionnaires until they provide valid responses to all mandatory questions, which are denoted by a red field status indicator. This field is visible only when the <strong>Depends on</strong> field is empty and the data type is not <strong>Checkbox</strong>. Questions that depend on other questions and check box questions cannot be mandatory.</td>
</tr>
<tr>
<td>Allow not applicable</td>
<td>Check box that determines whether to include a <strong>Not Applicable</strong> answer option for this question on survey questionnaires. User responses of <strong>Not Applicable</strong> are excluded from results calculations. This field is visible only if the data type is <strong>Choice</strong>, <strong>Likert Scale</strong>, <strong>Template</strong>, or <strong>Yes/No</strong>.</td>
</tr>
<tr>
<td>Allow Additional Information</td>
<td>If selected, the <strong>Additional Information Label</strong> field is enabled. The <strong>Additional Information Label</strong> field value is displayed as a field on the survey response page to provide additional information for a question. <strong>Note:</strong> This is not applicable for the <strong>String</strong> and <strong>Template</strong> data types.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Depends on</td>
<td>Setting used to make this a conditional question, meaning that it only appears when users answer another question a certain way. To make a question depend on another question, select an existing question from the list, which displays Checkbox, Choice, Template, and Yes/No questions of the same category as this question. Then, use the Displayed when field to set the conditions that cause this question to appear on surveys. The system prevents the creation of recursive dependencies between questions. For example, if Question A depends on Question B, Question B cannot depend on Question A.</td>
</tr>
<tr>
<td>Displayed when</td>
<td>Answer options for the selected Depends on question which, when chosen on surveys, display this question. This field is visible and required only when the Depends on field is set.</td>
</tr>
<tr>
<td>Min</td>
<td>Smallest numerical value to be used as an answer option for this question. This field is visible and required only if the data type is Choice, Likert Scale, Number, or Percentage.</td>
</tr>
<tr>
<td>Max</td>
<td>Largest numerical value to be used as an answer option for this question. This field is visible and required only if the data type is Choice, Likert Scale, Number, or Percentage.</td>
</tr>
<tr>
<td>String option</td>
<td>Selection that determines what kind of response text box appears for this question on survey questionnaires. This field is visible and required only if the data type is String.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source Field</td>
<td>Source table field that appears as a dynamic value for the question in a triggered survey. When this field value is selected, a <code>${param}</code> placeholder is added at the end of the question label.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can move this placeholder anywhere in the question label.</td>
</tr>
<tr>
<td></td>
<td>When a user takes the survey, the question with dynamic value is included in the survey instance and <code>${param}</code> placeholder is replaced with the source field value.</td>
</tr>
<tr>
<td></td>
<td>If the record table specified in the trigger condition does not match the source table specified for the survey, or if the system fails to get the dynamic value from the source record, the <code>${param}</code> placeholder is not replaced by any value and is displayed as is in the question.</td>
</tr>
<tr>
<td></td>
<td>For example, if the survey is triggered from a PRB record and the survey question is configured with a dynamic value from Incident, the <code>${param}</code> placeholder in the survey question label is not replaced by any dynamic value and is displayed as is.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When survey questions are translated to other languages by a survey admin, the <code>${param}</code> placeholder should not be translated.</td>
</tr>
<tr>
<td>Allow Sentiment Analysis</td>
<td>Includes this question for the sentiment analysis of a survey.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available only for String type questions.</td>
</tr>
<tr>
<td>Related Lists</td>
<td></td>
</tr>
<tr>
<td>Assessment Metric Definitions</td>
<td>Answer options for this question. This related list is available only if the Data type is Choice or Likert Scale.</td>
</tr>
</tbody>
</table>

6. Save the record.

**Note:**
- Be sure to create answer options if you select the Choice or Likert Scale data type.
- You cannot delete a survey question (metric) with user responses. To delete a survey question with user responses, you should delete the responses, and then delete the survey question.
Survey question data types

You must choose a data type for each survey question. The data type determines the format of the question and the kind of data that is collected on survey questionnaires.

The following data types are available for surveys:

Attachment data type

On questionnaires, users can attach one or more files to a question.

Users click the Manage Attachments icon and select one or more files in the Attachments pop-up window to attach to the question. From this window, users can:

- View a list of the attached files.
- View an attached file in a separate window.
- Rename an attached file.
- Add or delete files

Once a survey has been submitted, attachments cannot be updated or deleted.

Any type of file supported by the platform can be attached to a question. One or more files can be attached a question while taking a survey or completing an assessment.

The assessment administrator can see the attachments associated with an individual question as well as those associated with the survey.

See Administering Attachments for more information.

Boolean data type

On questionnaires, users select a check box beside a statement or leave it cleared.

If you select Boolean, you must fill in the Scale definition field. Select High if it is best when users select the check box.

Choice data type

On questionnaires, users select a value from a list of choices.
If you select **Choice**, you must fill in the **Scale definition** field and create answer options. Select **High** for the scale definition if the answer option with the largest metric definition **Value** is best.

**Note:** The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.

**Date and Date/Time data types**

The **Date** and **Date/Time** data types are similar.

- **Date:** On questionnaires, users select a date.
• **Date/Time**: On questionnaires, users select a date and time.

![Image of date and time selection](image)

**Likert Scale data type**

On questionnaires, users select a multiple choice value from a custom Likert scale. Each answer option is represented by a radio button on the scale. A Likert scale question that evaluates an application's ease of use might have the answer options **Easy**, **Average**, and **Difficult**.

![Image of Likert scale](image)

If you select **Likert Scale**, you must fill in the **Scale definition** field and create answer options. Select **High** for the scale definition if the answer option with the largest metric definition **Value** is best.

**Note**: The system sets the **Min** and **Max** fields automatically based on the **Value** settings for the associated metric definitions.

**Number data type**

On questionnaires, users enter a number.
If you select **Number**, you must fill in these additional fields:

- **Scale definition**: Select **High** if a larger number is better, such as for a question that measures the number of sales made in a quarter.
- **Min** and **Max**: Enter the smallest and largest numbers users can enter. State the range of acceptable answers in the question text.

**Percentage data type**

On questionnaires, users enter a number.

If you select **Percentage**, you must fill in these additional fields:

- **Scale definition**: Select **High** if a larger percentage is better, such as for a question that measures the percentage of work an agent has completed.
- **Min** and **Max**: Enter the smallest and largest numbers users can enter. Generally 0 and 100 are appropriate minimum and maximum values. If you choose values other than 0 and 100, it is usually best to state the range of acceptable answers in the question text.

**Reference data type**

On questionnaires, users select a value from a list that is generated from a specified reference table. The response field supports auto-completion.

*Note: Reference qualifiers are not supported.*

For example, a user could select a user name in response to a question if you specify User [sys_user] as the reference table.
String data type

On questionnaires, users enter text. When you select **String**, the **String option** field appears. Select one of the following options to determine how the string field appears on questionnaires:

- Single line
Template data type

On questionnaires, users select a value from a predefined series of answer options. To use this data type, a question template must be defined.

If you select Template, you must fill in these additional fields:

- **Template**: Select a template.
- **Scale definition**: Select High if the answer option with the largest template definition **Value** is best.

Yes/No data type

On questionnaires, users select **Yes** or **No** from a list.

If you select **Yes/No**, you must fill in the **Scale definition** field. Select **High** if **Yes** is the best answer.
**Image Scale data type**

On questionnaires, users select an image from a predefined set of images as their response. Image scale questions can also be used in a template for better performance with surveys that have the same type of answer options.

Five emojis, similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, you can upload additional images in JPG, PNG, or GIF format. Two images can be uploaded, one for selected case and another for unselected case. Larger size images are reduced to 64 x 64 pixels.

The result behavior depends on the presence of uploaded images. If no selected image is uploaded, then the question shows up blank.

<table>
<thead>
<tr>
<th>Selected image</th>
<th>Unselected image</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Unselected image loads. Clicking on the image changes it to the selected image.</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>Selected image loads with 50% opacity. Clicking on the image changes the opacity to 100%.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>A blank placeholder box is displayed.</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>A blank placeholder box is displayed.</td>
</tr>
</tbody>
</table>

**Note:** N/A option is not supported for image scale type question.

**Multiple selection data type**

On questionnaires, users can select multiple check boxes indicating all answers that apply. For instance, a user can be instructed to "Select all that apply" in a multiple selection question.
Ranking data type

On questionnaires, users can select a different order number for each option to rank them. Drag-and-drop functionality is also supported, which allows a user to either fill in the number, or simply drag an option.

One order number cannot be selected twice. This question can be mandatory and it can also be dependent on a parent question, but not vice versa.

Survey question template

Question templates define reusable sets of answer options for survey questions.
Question templates define reusable rating scales for answering questions, where each answer option on the scale is a template definition. For example, the template named **Satisfaction** represents a satisfaction scale and contains the following template definitions: **Very Satisfied**, **Satisfied**, **Neutral**, **Dissatisfied**, and **Very Dissatisfied**.

![Template definition](image)

**Template definition**

Templates are available for survey questions that have **Data type** set to **Template**. The following question templates are available in the base system. You can create or update a template as described in Create a survey question template.

<table>
<thead>
<tr>
<th>Name</th>
<th>Template definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>None, Few or little, Average amount, Many, Quite a lot</td>
</tr>
<tr>
<td>Complexity</td>
<td>Very Complex, Complex, Moderate, Simple, Very Simple</td>
</tr>
<tr>
<td>Frequency</td>
<td>Never, Seldom, Sometimes, Most of the time, All of the time</td>
</tr>
<tr>
<td>Likert 5</td>
<td>Strongly Disagree, Disagree, Neutral, Agree, Strongly Agree</td>
</tr>
<tr>
<td>Quality</td>
<td>Very Poor, Poor, Average, Good, Very Good</td>
</tr>
<tr>
<td>Satisfaction</td>
<td>Very Dissatisfied, Dissatisfied, Neutral, Satisfied, Very Satisfied</td>
</tr>
<tr>
<td>Size</td>
<td>Very Small, Small, Average, Large, Very Large</td>
</tr>
</tbody>
</table>

### Create a survey question template

You can create and administer question templates.

**Role required**: admin or survey_admin

Changes to a survey, such as the modification of question templates, apply to existing survey instances immediately. Templates that you create are available for use with both surveys and assessments.

1. Navigate to **Survey > Templates**.
   - Each template is stored as a record on the Assessment Metric Template [asmt_template] table.
2. Click **New**.
3. Enter a **Name**.
4. Right-click the form header and click **Save**.
5. In the **Assessment Template Definitions** related list, click **New**.
   - Create a template definition for each answer option you want to appear on a question.
6. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Enter the text to appear as the answer option.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter a numeric value, greater than or equal to zero, to which the answer option equates. Values are used in results calculations. When you view questions that use templates, answer options appear in order from smallest to largest Value. Each template definition for a given template must have a unique Value.</td>
</tr>
</tbody>
</table>

7. Click Update.

*Update min and max values to match templates*

If you use survey result calculation data, ensure that the **Min** and **Max** values for a question that uses a template are equal to the smallest and largest template definition **Value**.

Role required: admin or survey_admin

When you create a question of the **Template** data type, the system sets the **Min** and **Max** fields based on the template definition values. The fields for existing questions are not updated if you add a new template definition to a template or if you update the **Value** of an existing template. If the new **Value** is less than the minimum value or greater than the maximum value of any questions that use the template, update the questions accordingly.

1. Navigate to **Survey > Questions**.
2. Configure the list to show the **Min** and **Max** columns.
3. Add the following list filter condition: `[Template] [is] [<select the template you updated>]`.
4. Ensure the **Min** and **Max** values match the smallest and largest template definition **Value** for the selected template.
   - If the values do not match, edit the **Min** and **Max** values directly from the list.

   **Note:** When the data type is **Template**, a UI policy prevents the editing of **Min** and **Max** from the form.

*Add a metric category and metric in the question bank for surveys*

Reuse the question categories (metric categories) and questions (metrics) added in the question bank for surveys. You can add metric categories or metrics from the question bank to a survey, or from the survey to a question bank.

Role required: admin or survey_admin

Activate the Survey Question Bank Sample Data plugin (com.snc.question_bank_data) to access the demo data for the question bank.

1. Navigate to **Survey > Question Bank**.
2. Click **New**.
3. In the Metric Category form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the metric category.</td>
</tr>
</tbody>
</table>
4. Right-click on the title bar and click **Save**.
5. In the Assessment Metrics related list, click **New**.
6. In the Survey Question form, fill the fields. For information on these fields, see [Create or modify survey questions](#).
7. Click **Submit**.

*Configure metric categories or metrics for a survey using the question bank*

Reuse question categories (metric categories) and questions (metrics) from the **Question Bank** module while creating or updating a survey.

**Role required:** admin or survey_admin

Activate the Survey Question Bank Sample Data plugin (com.snc.question_bank_data) to access the demo data for the question bank.

1. Navigate to **Survey > View Surveys**.
2. Open a survey definition.
3. Optional: To add metric categories to a survey from the question bank in Platform, perform the following steps.
   a) In the Metric Categories related list, click **New Category from Bank**.
      The New Category from Bank dialog box is displayed with a list of all metric categories added in the question bank.
   b) Select the required categories and click **Add Selected**.
      A copy of the metric category and the corresponding metric definitions is created in the Metric Categories related list.

4. Optional: To add metrics to a survey from the question bank in Platform, perform the following steps.
   a) In the Metric Categories related list, open a metric category definition.
   b) In the Assessment Metrics related list, click **New Metric from Bank**.
      The New Metric from Bank dialog box is displayed with a list of questions available in the question bank.
   c) Select the required metrics and click **Add Selected**.
      A copy of the metric and the corresponding metric definitions is created in the Assessment Metrics related list of the category.

5. Optional: To add a metric category to the question bank from a survey in Platform, perform the following steps.
   a) In the Metric Categories related list, open a metric category definition.
   b) Click **Add to question Bank**.
      A copy of the category is created along with its metrics and metric definitions in the question bank.
6. Optional: To add a metric to the question bank from a survey in Platform, perform the following steps.
   a) In the Metric Categories related list, open a metric category definition.
   b) In the Assessment Metrics related list, open the required metric definition.
   c) Click **Add to Question Bank**.
      The Add to Question Bank dialog box is displayed.
   d) In the **Choose a question bank to add this question/metric** field, select a metric category that you want to add this metric to, and click **OK**.
      A copy of the metric and the corresponding metric definitions is created for the selected category in the question bank.

7. Optional: To add a metric category or metric to a survey from the question bank in Survey designer, perform the following steps.
   a) Open the survey in Survey Designer.
   b) Optional: To add a metric category from the question bank, from the **Categories** tab in the left panel, drag the required category banner and drop in the **Design** tab.
   c) Optional: To add a metric from the question bank, drag and drop the required metric from the **Questions** tab or the **Categories** tab.

   **Note:**
   - When you drag and drop a metric category, all dependencies within the category are also added to the survey.
   - From the **Categories** tab, you can drag and drop an individual metric within a metric category.
   - When you drag and drop a parent metric, all dependent questions are also added to the metric category.
   - When you drag and drop a child metric, only the child question is added to the metric category.

---

**Create or modify answer options**

You must create answer options, called metric definitions, for survey questions that have **Data type** set to **Choice** or **Likert Scale**.

Role required: admin or survey_admin

Changes to a survey, such as the addition or modification of answer options, apply to existing survey instances immediately.

1. Navigate to **Survey > Questions**.
2. Open a choice or Likert scale survey question.
3. In the **Assessment Metric Definitions** related list, open a metric definition or click **New**.
   Each answer option is stored as a record on the Assessment Metric Definition [asmt_metric_definition] table.
4. Complete the Assessment Metric Definition form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Text to appear as the answer option.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Numeric value, greater than or equal to zero, to which the answer option equates. Values determine the order in which answer options appear. See the example below. Values are also used to calculate survey results. Each metric definition for a given question must have a different Value.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

On survey questionnaires, the answer options for a question appear in order from smallest to largest **Value**. For example, consider the survey question *How do you feel?* with the answer options **Good**, **Neutral**, and **Bad**. The following table shows the answer option order based on the **Value**.

<table>
<thead>
<tr>
<th>Answer option</th>
<th>Value</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td>1</td>
<td>First</td>
</tr>
<tr>
<td>Neutral</td>
<td>3</td>
<td>Second</td>
</tr>
<tr>
<td>Bad</td>
<td>5</td>
<td>Third</td>
</tr>
</tbody>
</table>

If you use survey result calculations, ensure the question **Scale definition** is set appropriately based on the answer options. In the previous example, if you want the answer option **Good** to earn the highest score, the scale definition should be **Low** because **Good** has the smallest value.

### Change the order of survey questions

You can easily reorder survey questions at the category level or the question level.

**Role required:** admin or survey_admin

You can change the order in which the questions in one category appear relative to those in other categories for the same survey definition. If you add a new question manually after you create other questions, you may want to change the order of questions.

When you create questions using the survey creator, the system sets the **Order** field for the first question to **101**, the second to **102**, and so on. After you create a new question outside of the survey creator, the **Order** is set to **100** by default, which means it appears before all questions generated by the survey creator.

1. Navigate to **Survey > View Surveys** and open the appropriate survey definition.
2. In the **Metric Categories** related list, edit the values in the **Order** column.
3. To change the order of questions within a category, complete the following steps.
   a) Open the **Assessment Metrics** related list.
   b) Edit the values in the **Order** column.
4. Click **Update**.
Survey trigger conditions

Trigger conditions specify when to send a particular survey and the persons to send it to.

Survey administrators can use trigger conditions to configure the system to generate a survey instance each time a specified action occurs on a specified table, for example, when an incident or change request closes. The system sends the survey to users that are related to the triggering record, for example, incident callers or change request assignees. You can choose to send a survey every time the condition is met, or you can set a probability for the system to send a survey at random when the condition is met.

Trigger conditions are ideal for sending transactional surveys. Transactional surveys generally measure satisfaction with a recent experience, such as closing an incident or purchasing an item.

Note: Trigger conditions are comparable to survey conditions in legacy surveys. If you migrate a legacy survey that has survey conditions, ensure that the survey conditions are deactivated before you recreate them as trigger conditions.

Configure a trigger condition for a survey

Configure trigger conditions to specify when to send a particular survey and the persons to send it to.

Role required: admin or survey_admin

1. Navigate to Survey > Trigger Conditions.
2. Click New.

Note: Do not specify particular users for a triggered survey because only the specified users are allowed to take the survey.

3. Complete the form.

Trigger condition fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment</td>
<td>Survey to send.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to run the trigger condition on. You can select only tables in the current application scope. For example, to send a survey whenever an incident closes, select the Incident [incident] table.</td>
</tr>
<tr>
<td>User field</td>
<td>Field that stores the users you want to send the survey. You can select any field, on the selected table or on a referenced table, that references the User [sys_user] table. Use the tree picker to select a field.</td>
</tr>
</tbody>
</table>

Note: To avoid requiring users to log in to take a survey with a trigger condition, set the survey to Public.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeat interval</td>
<td>Minimum period that must pass before the trigger condition can resend the survey to the same user. For example, assume the repeat interval is set to 30 days. Even if the same user qualifies for multiple surveys from this trigger condition, the system can send only one survey every 30 days.</td>
</tr>
<tr>
<td>Note:</td>
<td>Ensure that the Schedule period of the selected survey definition is set to <strong>No Limit</strong>. If the schedule period is set to a different value, it prevents the trigger condition from sending surveys as expected.</td>
</tr>
<tr>
<td>Application</td>
<td>[Admin only] Application is set to Core.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this trigger condition is active (selected).</td>
</tr>
<tr>
<td>Business rule</td>
<td>[Admin only] Business rule the system creates to monitor the selected table. When the condition is met, the business rule sends the survey to the correct user. No configuration is necessary for this business rule.</td>
</tr>
<tr>
<td>Trigger randomly</td>
<td>Check box that determines whether to send the survey to the appropriate user every time the condition is met (cleared) or only a percentage of the time (selected).</td>
</tr>
<tr>
<td>Probability (%)</td>
<td>Approximate probability that the survey is sent each time the condition is met. For example, if the probability is set to 50, the system sends the survey approximately 50% of the time the conditions are met. There are no repeat interval restrictions is assumed. This field is visible and required only when <strong>Trigger randomly</strong> is selected.</td>
</tr>
</tbody>
</table>
| Related Field 1-4     | Field that contains a value you want to store for reporting purposes. You can pick any reference field on the selected table. When the trigger condition generates a survey instance, the system stores the value from the triggering record. Specify up to four fields.  
For example, select the Incident table, **Assigned to** and **Problem** as related fields. The system stores the assigned user and problem associated with the incident as Related record 1 and Related record 2 in the survey instance record. To view the fields, configure the form for any survey instance. |
<p>| Note:                 | You cannot use a related field for the ticket number because you cannot select the Number column. You can, however, use the trigger_id column of the table.                                                      |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Summary information to identify the trigger condition.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For a triggered record, the table title is used for the survey description.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition builder that defines the criteria that must be true to send the survey. For example, to send a survey whenever an incident closes, create the condition <code>[State] [is] [Closed]</code>.</td>
</tr>
</tbody>
</table>

You can also create a trigger condition directly from the survey creator. If you select **Certain users can take this survey, based on conditions** in the Survey User Access section, the Trigger Condition form opens automatically when you click **Save as Draft** or **Publish**.
<table>
<thead>
<tr>
<th>Assessment</th>
<th>Service Desk Satisfaction Survey</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Incident [incident]</td>
</tr>
<tr>
<td>User field</td>
<td>Click to select...</td>
</tr>
<tr>
<td>Repeat Interval</td>
<td>Days 30</td>
</tr>
<tr>
<td></td>
<td>Hours 00 00 00</td>
</tr>
<tr>
<td>Related Field 1</td>
<td>None</td>
</tr>
<tr>
<td>Related Field 2</td>
<td>None</td>
</tr>
<tr>
<td>Related Field 3</td>
<td>None</td>
</tr>
<tr>
<td>Related Field 4</td>
<td>None</td>
</tr>
<tr>
<td>Description</td>
<td>Send incident callers service desk satisfaction surveys when incidents are closed</td>
</tr>
<tr>
<td>Condition</td>
<td>Add Filter Condition Add &quot;OR&quot; Clause</td>
</tr>
<tr>
<td></td>
<td>— choose field —</td>
</tr>
<tr>
<td></td>
<td>— oper —</td>
</tr>
<tr>
<td></td>
<td>— value —</td>
</tr>
<tr>
<td>Application</td>
<td>Global</td>
</tr>
<tr>
<td>Active</td>
<td></td>
</tr>
<tr>
<td>Business rule</td>
<td></td>
</tr>
<tr>
<td>Trigger randomly</td>
<td></td>
</tr>
</tbody>
</table>
**Trigger condition example**

You can send out auto-triggered surveys when an incident is closed or resolved.

A trigger condition is configured as follows:

- **Assessment**: Service Desk Satisfaction Survey
- **Table**: Incident [incident]
- **User field**: Caller
- **Repeat interval**: 30 days
- **Active**: true
- **Trigger randomly**: false
- **Related Field 1**: Assigned to
- **Related Field 2**: Problem
- **Condition**: [State] [is] [Closed] [or] [State] [is] [Resolved]

Fannie Steese is the caller on incident INC00004305 that is assigned to Boris Catino, a service desk technician. Boris creates PRB010101 based on Fannie's complaint and closes the incident. The system creates a survey instance assigned to Fannie so she can rate her satisfaction with the incident experience.

Because two related fields were selected as part of the trigger condition, the survey instance stores the following information from the incident:

- User (Related Field 1): **Boris Catino**
- Problem (Related Field 2): **PRB010101**
- Task (automatically created): **INC00004305**

Because the task field is automatically populated, UI-based filtering by dot-walking on incidents (or any task-based table) is supported when creating a report on survey results. For example, you can query all survey instances related to incidents assigned to a group (survey reports on all incidents assigned to networking group, for instance).

**Note**: Even though the trigger condition is set to be triggered each time that the conditions are met, the **Repeat interval** setting ensures that Fannie does not receive another survey for another of her incidents closes within 30 days of the first incident.

**Survey report example based on task field**

One of the most common use cases for Surveys is to send out an auto-triggered survey when an incident, request, or task is closed. Once you get the survey results back, you can filter the results by users and groups related to the ticket, such as Assignment Group, or Assignee.

Filtering the survey results provides more detail on how people and teams are performing based on ticket data. Since this information is automatically captured, you can dot-walk while filtering the data (instead of utilizing a related field on the Survey trigger condition form, as previously required).
To create a report on incident-triggered survey responses by Assignment group, set up the report on the Task Assessment Details by navigating to ReportsView/Run and clicking Create a report.

Survey distribution

There are several ways for survey administrators to distribute surveys to users. Surveys are distributed using any of the following methods.

- Send survey invitations to users
- Share a survey URL that opens the survey directly.
- Create a module that opens a survey.

Send survey invitations to users

You can send survey invitations using the Assign Survey or Send Invitations buttons on the Survey Definition form.

Role required: admin or survey_admin

Use the Send Invitations button to immediately assign survey instances to each survey user that is listed in the survey definition. Use the Assign Survey button to assign a survey instance to any one user at a time.

Each of the buttons generates survey instances assigned to the appropriate users. In addition, if the instance is configured to send email, the system generates survey notifications. For either button to be available, the survey definition must meet all of the following conditions.

- Active check box is selected.
• **State** is **Published**.
• Survey is associated with at least one question.

**Note:** You (or a trigger) can send more than one instance of a survey to a user at any time.

1. Navigate to **Survey > View Surveys**.
2. Select an active, published survey.
3. Complete one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign a survey to users listed in the Survey Users related list</td>
<td>Click <strong>Send invitations</strong>.</td>
</tr>
<tr>
<td>Assign a survey to any user</td>
<td>Click <strong>Assign Survey</strong> and select one or more users, and then click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

The system creates a survey instance assigned to the user or users, assuming the user is eligible to receive a new survey instance. When you use the **Assign Survey** button, the selected user is not saved as a survey user.

### Define a recipients list for surveys

Use a recipients list to define targeted set of users for whom the survey invite can be sent. You can use a recipients list for multiple surveys.

**Role required:** admin or survey_admin

1. Navigate to **Survey > Administration > Recipients Lists**.
2. Click **New**.
3. In the Recipients List form, add the field information:

**Recipients List form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the recipients list.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of users to include in the list. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• Contacts</td>
</tr>
<tr>
<td></td>
<td>• Internal Users</td>
</tr>
<tr>
<td>State</td>
<td>State of the recipients list.</td>
</tr>
<tr>
<td></td>
<td>• <strong>New</strong>: List has not yet been generated.</td>
</tr>
<tr>
<td></td>
<td>• <strong>In Progress</strong>: List is currently being generated. (You can see this state only when generating a very large list of recipients.)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Complete</strong>: List is generated.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>Method used to generate the recipients list. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• Upload File: Upload an Excel file with the recipients list using the specified template.</td>
</tr>
<tr>
<td></td>
<td>• Dynamic Condition: Run a script or condition builder to create the recipients list.</td>
</tr>
<tr>
<td>Choose File</td>
<td>Allows you to download an Excel template, and then upload the Excel file with user information using the specified template.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available only if the Method is Dynamic Condition.</td>
</tr>
<tr>
<td></td>
<td>The templates vary based on the entity selected in the Type field. For accounts, the template includes columns for sys_id and account number values. For contacts, consumers, and internal users, the template includes columns for sys_id and email values.</td>
</tr>
<tr>
<td>Show Script</td>
<td>If selected, displays the script to create the recipients list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available only if the Method is Dynamic Condition.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to create the recipients list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available only if the Method is Dynamic Condition and the Show Script check box is selected.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that stores the user information. The table is selected based on the Type field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available only if the Method is Dynamic Condition.</td>
</tr>
<tr>
<td>User Field</td>
<td>Table field that refers to users.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is available only if the Method is Dynamic Condition.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditions</td>
<td>Condition builder to create the recipients list based on the specified table and user field. A condition is made up of a selected field, an</td>
</tr>
<tr>
<td></td>
<td>operator, and a value. Add conditions using the AND and OR buttons. Delete conditions by clicking the Delete button to the right of a condition.</td>
</tr>
</tbody>
</table>

**Note:** This field is available only if the **Method** is **Dynamic Condition**.

---

4. **Click Submit.**

   For recipients lists created by the file upload, clicking **Submit** validates the records in the Excel file. Following validation, the system displays a pop-up window with the upload results, including valid and invalid user records.

5. **Optional:** To get the updated user list, navigate to the recipient list and click **Refresh Recipient List**.

---

### Add a recipients list to a survey

Send the survey invites to targeted sets of users by adding a recipients list to a survey.

**Role required:** admin or survey_admin

Recipients lists should be pre-defined in the Recipients Lists submodule. For more information on defining recipients lists, see Define a recipients list for surveys.

1. **Navigate to Survey > View Surveys.**

2. **Open a survey definition.**

3. **Perform any of the following steps.**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Platform</td>
<td>a. Under the <strong>Survey Recipients Lists</strong> related list, click <strong>New</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. In the Survey Recipients Lists form, from the <strong>Recipients List</strong> list, select the required recipients list.</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Submit</strong>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>From Survey Designer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>Under the <strong>Availability</strong> tab, for the <strong>Accessible By</strong> field, select <strong>Specific users</strong>.</td>
</tr>
<tr>
<td>b.</td>
<td>In the <strong>Add recipients lists</strong> list, select the required recipients list.</td>
</tr>
<tr>
<td>c.</td>
<td>To send the survey to users, click <strong>Save and Publish</strong>.</td>
</tr>
</tbody>
</table>

4. **To send survey invites to all survey users and recipients lists, click **Send Invitations.**

---

**Note:**
Embed a survey within the Outlook email client

Embed an interactive survey in the email notification sent to a user. The user can answer the survey questions and submit the survey from the email client instead of opening the survey in a new browser tab.

Role required: admin or survey_admin

The Outlook Actionable Messages plugin (com.sn_ms_oam) should be activated.

Note:
- Outlook Actionable Message (OAM) is not supported for Outlook 2016 for Mac. For information about detailed support matrix, refer to the Microsoft website.
- Actionable messages are supported only for emails sent from the @service-now.com email address. If you are sending an email from a customized email address, you should register as a new service in the Microsoft website setting the scope as Organization. Specify the provider ID value in the sn_ms_oam.outlookactionable.originator property.
- Actionable messages are based on the Sender Policy Framework (SPF)/DomainKeys Identified Mail (DKIM) validation for the email sender verification. If an email recipient receives email via an external provider, emails may are not rendered as adaptive cards.
- You cannot customize the default actionable message templates.

1. Navigate to System Notification > Email > Notifications.
2. For the Survey User Invite notification, in the What it will contain tab, add the following script in the Message field in addition to the existing information.

   ```
   ${mail_script:include_survey_actionable}
   ```

   This script includes the Outlook actionable message in the email notification sent to the user.

3. Navigate to Survey > View Surveys, and open a survey.
4. To send an email notification to the survey user, select the Send notifications check box.
5. Select the Outlook Actionable Message check box and save the survey.

Note:
- The following questions are not supported for an embedded survey:
  - Attachment
  - Date
  - Datetime
  - Template
  - Reference
  - Image Scale
  - Ranking
- Dependant questions are not supported.
- Signature is not supported.
• Mandatory questions are supported.

In both the Platform UI and Survey Designer, a validation is run to ensure all survey questions are supported.

6. Click **Assign Survey** and assign the survey to a user.
   An email notification with the embedded survey is sent to the user. The user can take the survey and submit it from the email client instead of opening the survey in a new browser tab.

### Enable localization for a survey

Enable a survey user to take a survey in multiple languages.

**Role required:** admin or survey_admin

The plugin for the language that you want the survey to be available in should be installed.

**Note:** Localization is applicable only for public surveys.

1. Navigate to **Survey > Administration > Properties.**
2. Enable the **Enable/Disable whether to show language picker when a public survey is taken** (`show_lang_picker_for_publicsurveys`) property.
3. In the System Settings window, from the **Language** list, select the language that you want the survey to be available in.

**Note:** The **Language** list is available only when a language plugin is installed.

4. Navigate to **Survey > View Surveys** and open a public survey.
5. Enter the translated text for the survey title, questions, and answers.
6. Save and publish the survey.

**Note:** The localization is also applicable in Service Portal if the **Assessment Properties Allow survey link from email to open in service portal view (applies only for surveys) (sn_portal_surveys.sp_survey.email_redirection)** property is enabled.

- The survey is available for survey users in the translated language.
- Users can change the language of the survey using the language picker.

### Survey URLs

You can distribute a survey by giving survey users a survey URL.

Survey administrators can obtain one of the following types of URLs.

- A general URL for a survey, which users can open to take the survey questionnaire. The following process occurs.
  - When someone opens the URL, the system ensures that the person is logged in. It then searches for an instance of the associated survey that is assigned to the logged-in user.
  - If a survey instance is found, the appropriate action occurs based on the **State** of the survey instance (see table). If there are multiple active survey instances (Ready to take or In progress), the instance with the earliest due date opens.
  - If no survey instance is found, the system creates a new instance for the survey, assigns it to the user, and opens the survey questionnaire.
• A URL for a specific survey instance, which the assigned user can open to take the survey questionnaire. The following process occurs.
  • When someone opens the URL, the system ensures the person is logged in as the user the survey instance is assigned to. Only the assigned user can access the survey questionnaire.
  • The appropriate action occurs, depending on the State of the survey instance (see table).

Survey states

<table>
<thead>
<tr>
<th>Survey instance state</th>
<th>Action upon opening URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready to take: User has not saved any responses.</td>
<td>The survey questionnaire appears for the user to begin. The user can save or submit responses.</td>
</tr>
<tr>
<td>In progress: User has saved at least one response.</td>
<td>The survey questionnaire appears for the user to continue. Any previously saved responses are displayed. The user can save or submit responses.</td>
</tr>
<tr>
<td>Complete: User has submitted all required responses.</td>
<td>If the schedule period is No Limit or if the period restriction has expired, the survey questionnaire for a new survey instance appears for the user to begin. If the schedule period restricts the number of times a user can take the same survey, and the period restriction has not expired since the user last completed survey, an error message appears.</td>
</tr>
</tbody>
</table>

If someone opens a URL for an unpublished or deactivated survey, an error message appears.

Obtain and distribute a general survey URL
You can distribute a general survey URL to allow any eligible user to open a survey questionnaire.

Role required: admin or survey_admin
The general URL is available on the Survey Definition form and on the survey creator. You can also email the URL for a public survey that is published.

1. Navigate to Survey > View Surveys.
2. Open a survey definition from the Assessment Metric Types list.
3. To view or copy the URL, click the View Survey URL related link.
   This related link is visible only if the survey definition is Active.
4. To distribute the URL to users, paste the copied URL as desired, or click the Email button to send via email.
   The Email button is visible only for a public survey that is published.

When a survey user clicks the general survey URL, the system creates a survey instance for the survey user as long as the user does not have an instance in the Ready to take state. The system is configured by default to send an email notification when a survey instance is generated.

As a result, the survey user receives a second notification in addition to the notification that you sent with the general survey URL. This may confuse the survey user. To avoid this issue, you can deactivate auto-notification.

Deactivate auto-notification for surveys
When you send a survey notification with a general survey URL to a survey user, the user may receive a second system-generated notification. To avoid this issue, you can deactivate auto-notification.
Role required: admin or survey_admin

1. Navigate to System Notification > Email > Notifications.
2. Open the Survey User Invite notification.
3. Configure the form to add the Send to event creator check box to the Who will receive section.
   The Send to event creator check box is selected by default.
4. Clear the Send to event creator check box.
   The system will no longer send auto-notification messages to survey users.

Obtain a survey instance URL
You can distribute a survey instance URL to allow the assigned user to open a survey questionnaire.
Role required: admin or survey_admin
The survey instance URL is available on the survey instance record.

1. Navigate to Survey > Survey Instances.
2. Open the instance for the survey.
3. To view or copy the URL, click View Instance URL related link.
   The related link is available only when the survey instance State is Ready to take or In progress and the associated survey definition is Active.
4. In the dialog box, select and copy the URL then click OK or Cancel.
5. Distribute the URL to the assigned user.

Test a survey URL
When there are survey users associated with a survey, the survey is restricted so only those users can use the survey URL. You can test the survey URL to ensure it is restricted.
Role required: admin or survey_admin

1. Navigate to Survey > View Surveys and open a survey for which you are not a survey user.
2. Under Related Links, click View Survey URL.
3. Copy the URL and click OK or Cancel.
4. Navigate to the URL.
   You see a message that you are not authorized to take the survey.

Create a survey module
You can create a module that opens a survey.
Role required: admin or survey_admin
When a user clicks a survey module, the system performs one of the following actions, depending on the configuration options for the survey and other factors.
• Creates a new survey instance
• Opens an existing survey instance
• Displays an error message.

1. Perform the appropriate action for your version of the UI:
   • UI16: Point to the application menu that contains the module to which you want to add the survey module and click the edit application (pencil) icon.
   • UI15: Right-click the application menu you want to add the module to and select Edit Application Menu
2. In the Modules related list, click New.
3. Complete the following fields.
• **Link type**: Assessment
  Do not select Survey, which is used for legacy surveys only.
• **Assessment**: Select the survey you want the module to open.

4. Complete and save the form.

**Sharing surveys: export and import**

You can export a survey and then import it to a different ServiceNow instance.

**Note:** Update sets are available in the Helsinki release and should be used to move data from one instance to another. For information about update sets, see System update sets.

The system exports a single XML file that contains a survey definition [asmt_metric_type] and the associated records, including the following.

- Assessment Metric Template [asmt_template]
- Assessment Template Definition [asmt_template_definition]
- Metric definitions [asmt_metric_definition] (survey question answer options)
- Scheduled Jobs associated with the Survey [sys_trigger]
- Survey categories [asmt_metric_category]
- Survey questions [asmt_metric]
- Survey users [asmt_m2m_category_user]
- Trigger Condition [asmt_condition]

**Export a survey**

You can export a survey and then import it to another instance.

Role required: admin, survey_reader, or survey_admin

For information about update sets, see System update sets.

1. Navigate to Survey > View Surveys.
2. Right-click the name of a record to show the context menu.
3. Select Export Assessment.
4. If applicable, follow the prompt in your browser to save the XML file.

**Import a survey**

You can import a survey that has been exported as an XML file. The exported XML file does not contain result data.

Role required: admin or survey_admin

**Note:** Update sets are available in the Helsinki release and should be used to move data from one instance to another. For information about update sets, see System update sets.

1. Verify that the target instance has assessments enabled.
2. Follow the steps in #unique_2742 to import the assessment.

**Use update sets for surveys and assessments**

Use an update set to capture changes to surveys and assessments.

Role required: admin or survey_admin

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
When developing surveys and assessments, you can use an update set to capture the changes and move them from a development instance to a production instance. Once an update set is created and marked current, all of the updates to the following tables are recorded in the update set.

The following tables are now update set enabled and also extend the application file:

- Assessment Metric Templates [asmt_template]
- Assessment Template Definitions [asmt_template_definition]
- Assessment Metric Definitions [asmt_metric_definition]: survey question answer options
- Schedule [sys_trigger]: scheduled jobs associated with the survey
- Assessment Metric Categories [asmt_metric_category]: survey categories
- Assessment Metrics [asmt_metric]: survey questions
- Assessment Category Users [asmt_m2m_category_user]: survey users
- Trigger Conditions [asmt_condition]

**Configure a survey in the Connect chat support**

Enable a user to take a survey after chatting with a survey agent.

Role required: admin or survey_admin

**Note:** The Connect Support plugin (com.glide.connect.support) should be activated.

1. Navigate to **Survey > Chat survey**.
2. Click **New**.
3. In the Chat Survey form, fill the fields.

**Chat Survey form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey</td>
<td>Survey whose instance should be available in Connect Support.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of chat where the survey is available.</td>
</tr>
<tr>
<td></td>
<td>• Connect: Survey is available in Connect Support.</td>
</tr>
<tr>
<td>Chat queue</td>
<td>Chat queue where the survey is available.</td>
</tr>
<tr>
<td>Active</td>
<td>Specifies if the chat survey configuration is active.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the chat survey configuration.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
   When a support agent of the assignment group associated with the chat queue ends a chat with a user, the survey instance is available in the chat window for the users.

**Sentiment analysis for surveys**

You can use sentiment analysis to determine whether user responses for a survey are considered positive, negative, or neutral.

Activate the Sentiment Analysis (com.snc.sentiment_analysis) plugin.

For a survey, you can select questions that should be used for analysis. The survey responses of these questions are sent to the thirdparty platforms for analysis through the specified connector configurations.
Note: You can only use string type questions for sentiment analysis.

The sentiment analysis results are displayed under **Survey > Question Sentiment Results**. The sentiment label is based on the normalized score:

<table>
<thead>
<tr>
<th>Normalized score</th>
<th>Sentiment label</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1 to 0</td>
<td>Negative</td>
</tr>
<tr>
<td>0</td>
<td>Neutral</td>
</tr>
<tr>
<td>0 to 1</td>
<td>Positive</td>
</tr>
</tbody>
</table>

**Configure a sentiment connector**

Specify the service URL and other configuration information for third party APIs that are used for sentiment analysis.

Role required: admin

1. Change the scope of the current session to **Sentiment Analysis**.
2. Navigate to **Sentiment Analysis > Sentiment Connector Configurations**.
3. Add or edit the connector configuration for a third party vendor such as Google, IBMWatson, and MSAzure.

Note: By default, placeholders are available for configuring connectors for Google, IBMWatson, and MSAzure.

**Sentiment connector fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the sentiment analysis connector configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the connector configuration.</td>
</tr>
<tr>
<td>Credential Alias</td>
<td>Credential alias associated with the connector configuration. It has a reference to the system level table (sys_alias_list).</td>
</tr>
<tr>
<td>Default</td>
<td>Check box to make this as the default connector configuration.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the connector configuration.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to call the Sentiment Analysis API and the normalize the values.</td>
</tr>
</tbody>
</table>

4. Configure the connector credentials
   a) Open the record referred in the **Credential Alias** field.
   b) Under the **Connections** tab, select the connection.
   c) In the **Connection URL** field, enter the value.
   d) Open the record referred in the **Credentials** field.
   e) Enter the credential information.
Note:
- You should obtain the connection credentials from the respective third-party vendors.
- If the credential is an API key, specify its value. If the credential is basic authentication, that is, user name and password, specify the corresponding information.

f) Select the Active check box and click Update.

5. Select the Active check box for the connector configuration and click Update.

Sentiment analysis properties

You can use the sentiment analysis properties to customize the Sentiment Analysis module.

<table>
<thead>
<tr>
<th>Sentiment analysis properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Response time for the outbound call of Sentiment Analysis API (sn_nlp_sentiment.glide.sentiment.transaction.timeout)</td>
</tr>
</tbody>
</table>

Sentiment analysis results

The sentiment analysis results view contains a bar chart that displays the percentage of positive, negative, and neutral results, along with the instance count for each category.

Color indicators

Following are the color indicators in the bar chart:
- Green: Positive
- Red: Negative
- Blue: Neutral

Quick start tests for Assessments and Surveys

Validate that Assessments and Surveys still work after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Assessments and Surveys quick start tests require activating the Automated Test Framework Survey plugin (com.glide.automated_testing_impl.Survey).

<table>
<thead>
<tr>
<th>Test Suite for Survey</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Survey: Basic Platform Based Test</td>
</tr>
<tr>
<td>Survey: Clone Action</td>
</tr>
<tr>
<td>Survey: Platform test for Dynamic Validation</td>
</tr>
</tbody>
</table>
## Legacy survey migration

Users with the survey_admin role can migrate legacy survey data to create copies of legacy surveys and their related records in assessment tables. The Survey Management application, which is built on the assessment engine, is available as an alternative to legacy surveys.

The following legacy survey components are migrated:

- Survey masters
- Supported survey questions and question choices
- Survey instances
- Survey responses

Legacy survey conditions are not migrated and must be recreated as trigger conditions.

### Note:

- The **Legacy Surveys** and **Legacy Administration** modules are available on instances upgraded from a previous release but not available for new instances. Customers using legacy survey or survey wizard should plan to migrate to the Survey Management application to create modern and high quality surveys for their users.
- The following legacy survey plugins are inactive by default, and are available upon request:
  - Best Practice - Task Survey Management (ID: com.snc.bestpractice.task_survey)
  - Survey Management (ID: com.glideapp.survey)
  - Assessment Components (ID: com.snc.assessment)
  - Survey Wizard (ID: com.glideapp.survey_wizard)
- Survey wizards cannot be migrated.

### Migrate a legacy survey

Migrate a legacy survey and its related records to take advantage of a more powerful feature set.

Role required: admin or survey_admin

To avoid timing out for very large surveys, you can disable the transaction quota. See #unique_2750.

1. Navigate to **Survey > Legacy Surveys > Masters**.
   The list of legacy survey masters appears. By default, the list shows only survey masters that have not been migrated. To show all survey masters, remove the **Assessment is empty** breadcrumb.
2. Open a survey and click the **Migrate to New Survey Management** related link or **Migrate to New Survey Management** in the title bar.
   A dialog box describes what happens when you migrate the survey. Note that certain types of survey questions cannot be migrated.
3. Click **OK**.
   The system generates records on assessment tables based on the survey master, eligible questions and choices, results, and other related survey components. The original survey components are unaffected.
System messages may appear at the top of the Survey form to notify you of questions that could not be migrated and to advise you to review migrated Multiple Choice questions.

4. Optional: Click the reference icon beside the Assessment field to view the new survey definition.

5. Optional: Remove survey users from the assessment survey if you want all users to be able to take it. When you migrate a survey, any users who have taken it are automatically associated with the assessment survey and become survey users. When there are survey users associated with an assessment survey, only those users can take it.

6. Deactivate any survey conditions associated with the survey by completing the following steps.
   a) Navigate to Survey > Legacy Administration > Survey Conditions.
   b) In the Active column, ensure the value is false for any survey conditions that reference the migrated survey.

7. Navigate to Survey > Administration > Trigger Conditions to create new trigger conditions for the migrated survey.

The Migrate to Assessment related link on the legacy survey record becomes unavailable after the migration. However, if you delete the record referenced in the Assessment field, the related link reappears and you can migrate the legacy survey again.

Survey question migration

Before you migrate a legacy survey, understand that some legacy survey questions cannot be migrated due to incompatible question types.

Legacy survey questions are migrated from the Survey Question [survey_question_new] table to the Assessment Metric [asmt_metric] table. In legacy surveys, the Type field on the Survey Question table determines how the question renders on the survey questionnaire. In assessment surveys, the Data type field on the Assessment Metric table serves a similar purpose. Certain legacy survey types are not supported in assessment surveys.

The following table shows the conversion path for each legacy survey question type to an assessment data type, if there is one.

### Survey question migration

<table>
<thead>
<tr>
<th>Legacy survey type</th>
<th>Assessment data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Break</td>
<td>Not available</td>
</tr>
<tr>
<td>CheckBox</td>
<td>Checkbox</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date/Time</td>
</tr>
<tr>
<td>HTML</td>
<td>Not available</td>
</tr>
<tr>
<td>Label</td>
<td>Not available</td>
</tr>
<tr>
<td>List Collector</td>
<td>Not available</td>
</tr>
<tr>
<td>Lookup Multiple Choice</td>
<td>Not available</td>
</tr>
<tr>
<td>Lookup Select Box</td>
<td>Not available</td>
</tr>
<tr>
<td>Macro</td>
<td>Not available</td>
</tr>
<tr>
<td>Macro with Label</td>
<td>Not available</td>
</tr>
<tr>
<td>Multi Line Text</td>
<td>String (String option set to Multiline)</td>
</tr>
</tbody>
</table>
### Migrated components

When you migrate a survey, the system maps records from survey tables to assessment tables.

To create a functional survey on the assessment framework, the system converts survey records to the most logical equivalent assessment survey records. This may mean multiple assessment survey records represent one legacy survey record.

#### Migrated components

<table>
<thead>
<tr>
<th>Survey component</th>
<th>Assessment survey components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey master [survey_master]</td>
<td>• Survey definition [asmt_metric_type]</td>
</tr>
<tr>
<td></td>
<td>• Assessable record [asmt_assessable_record], for system use only</td>
</tr>
<tr>
<td></td>
<td>• Survey category [asmt_metric_category]</td>
</tr>
<tr>
<td>Survey question [survey_question_new]</td>
<td>• Survey question [asmt_metric]</td>
</tr>
<tr>
<td>Question choice [question_choice]</td>
<td>• Assessment metric definition [asmt_metric_definition]</td>
</tr>
<tr>
<td>Survey instance [survey_instance]</td>
<td>• Assessment group [asmt_assessment], for system use only</td>
</tr>
<tr>
<td></td>
<td>• Survey instance [asmt_assessment_instance]</td>
</tr>
<tr>
<td>Survey response [survey_response]</td>
<td>• Survey instance question [asmt_assessment_instance_question]</td>
</tr>
<tr>
<td></td>
<td>• Survey response [asmt_metric_result]</td>
</tr>
<tr>
<td></td>
<td>• Category result [asmt_category_result], for system use only</td>
</tr>
</tbody>
</table>

#### Migrated question review

To maintain accurate result calculations, you may need to make minor adjustments to some of the migrated survey records to ensure results are calculated correctly.
The assessment engine provides a built-in result calculation feature that converts each survey response to a score between 0 and 10. The configuration required to maintain accurate result calculations is advanced and is not recommended for basic survey implementations. If you do not plan to use result calculation data, ignore the information in this section.

For each legacy question migrated, the system creates a survey question record on the Assessment Metric [asmt_metric] table. For legacy questions of the Multiple Choice and Select Box types, the system also creates a metric definition record, on the Assessment Metric Definition [asmt_metric_definition] table, for each legacy question choice.

<table>
<thead>
<tr>
<th>Survey question choice field</th>
<th>Related metric definition field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Display</td>
</tr>
<tr>
<td>Value (can be any string value)</td>
<td>Value (must be a numerical value)</td>
</tr>
<tr>
<td>Order</td>
<td>Value (metric definition with smallest Value is first)</td>
</tr>
</tbody>
</table>

When the system migrates legacy survey question choices, it uses the legacy Order to set each metric definition Value. For the legacy question choice with the smallest Order, the corresponding metric definition Value is set to 1. For the legacy question choice with the next smallest Order, the metric definition Value is 2, and so on.

The Scale definition field on the migrated Survey Question form determines whether smaller or bigger metric definition values equate to a good score in survey result calculations. By default, the scale definition is set to High, meaning bigger values are good. When you migrate a legacy survey, check that the default scale definition makes sense for each question.

For example, the following tables depict a sample migrated question and the metric definitions automatically created for it. Recall that the system uses the order of the legacy survey question choices to set the metric definition value. Excellent has the lowest Order value, so when the system creates a metric definition for this question choice, the Value is set to 1. In this case the default scale definition value, High, does not make sense, as the system will calculate the worst scores for responses of Excellent.

<table>
<thead>
<tr>
<th>Question choice text</th>
<th>Question choice value</th>
<th>Question choice order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excellent</td>
<td>A</td>
<td>100</td>
</tr>
<tr>
<td>Good</td>
<td>B</td>
<td>200</td>
</tr>
<tr>
<td>Fair</td>
<td>C</td>
<td>300</td>
</tr>
<tr>
<td>Poor</td>
<td>D</td>
<td>400</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Metric definition display</th>
<th>Metric definition value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excellent</td>
<td>1</td>
</tr>
<tr>
<td>Good</td>
<td>2</td>
</tr>
<tr>
<td>Fair</td>
<td>3</td>
</tr>
<tr>
<td>Poor</td>
<td>4</td>
</tr>
</tbody>
</table>
If there are no **Order** values for the legacy survey question choices, the system sets each corresponding metric definition **Value** based on the alphanumeric order of the legacy **Text** value.

**Migrated question:** Please rate the overall quality of your service.

<table>
<thead>
<tr>
<th>Metric definition display</th>
<th>Metric definition value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excellent</td>
<td>1</td>
</tr>
<tr>
<td>Good</td>
<td>2</td>
</tr>
<tr>
<td>Fair</td>
<td>3</td>
</tr>
<tr>
<td>Poor</td>
<td>4</td>
</tr>
</tbody>
</table>

You may also need to change the **Scale definition** setting for other migrated questions. For details, see the scale definition recommendations for each survey question data type.

**Task Communications Management**

Task Communications Management (TCM) provides a framework for defining and managing a communication process for any entity that extends the task table.

**Explore**
- Task Communications Management process
- Slack Communication

**Set up**
- Activate Task Communications Management

**Administer**
- Working with Task Communications Management

**Use**
- NA

**Develop**
- Developer training
- Developer documentation

**Integrate**
- NA

**Troubleshoot and get help**
- Ask or answer questions in the Incident Management forum
- Search the HI Knowledge Base for known error articles
- Contact ServiceNow Technical Support

**Task Communications Management process**

Task Communications Management helps you to streamline the process by creating designated communication plans for effective communication during an event. The communication plan, with its defined tasks, helps you to focus on resolving the current issue instead of deciding when to send a communication, what information to share, and whom to inform.
Task Communications Management basic components

How Task Communications Management works

With Task Communications Management, you can predefine a communication plan for an event such as major incident, planned maintenance, and release. Each plan generally involves a series of tasks that define different communication and collaboration activities along with frequency and method of communication. For each task, you must specify the communication channel for contacting the stakeholders. You can also define templates for email and SMS messages.

After defining the task and channel for communication, you can define the contacts or the target audience to be contacted for each task.

After a communication plan is defined, the plan gets associated with the appropriate task table based on the conditions defined. Thereafter, the tasks defined in the plan get executed sequentially and stakeholders are contacted as defined in the plan. The communication plan makes communication and collaboration process smoother and brings a quicker resolution of the issue.

Task Communications Management flow in major incident management

Assume that you want an incident communication plan generated for a high-priority major incident.

• As the major incident manager, you can predefine a communication plan and the conditions that drive its attachment. In this case, the conditions are: Priority = High and Major Incident state = Accepted. Consider that the target audience is the technical stakeholders of the incident and the communication plan definition is named Technical Communications.

• The plan definition can have multiple communication task definitions such as:
  • Initiate Technical Communications
  • Technical Status Update
• Each communication task definition also specifies the channel of communication and the communication frequency (one time or recurring).
  • Initiate Technical Communications uses email as a channel of communication and communication frequency is one time.
  • Technical Status Update uses email and SMS as channel of communication and the communication frequency is recurring.
• The target audience for in the communications is defined as communication contact definitions on the plan definition. In this case, consider Service owners of the affected configuration items (CIs) related to the incident as technical stakeholders.
• When an incident meets these conditions, an incident communication plan together with its tasks gets attached to the incident record.
• As the major incident manager, you can effectively carry out the communication without any delay in the resolution of the major incident.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, refer to the ServiceNow Store version history release notes.

Task Communications Management plugins

The Task Communications Management plugins is activated in the base system. The plugin includes demo data.

Activate Task Communications Management

The Task Communications Management plugin (com.snc.task_communication_management) is activated when you activate the Incident Communications Management plugin (com.snc.iam) or the Incident Management - Major Incident Management plugin (com.snc.incident.mim). This plugin includes demo data and activates related plugins if they are not already active.
Role required: admin
Task Communications Management activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Management</td>
<td>The Contact Management plugin manages the connections between users or groups and other resources in the system.</td>
</tr>
<tr>
<td>[com.snc.contact_management]</td>
<td></td>
</tr>
<tr>
<td>Targeted Communications</td>
<td>The Targeted Communications plugin provides a way to publish and send out newsletter like articles to targeted internal or external customers.</td>
</tr>
<tr>
<td>[com.sn_publications]</td>
<td></td>
</tr>
</tbody>
</table>

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, they will receive the following error: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.*

### Components installed with Task Communications Management

Several types of components are installed with the Task Communications Management plugin, including tables and user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

#### Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Plan Admin [sn_comm_management.comm_plan_admin]</td>
<td>Provides overall accountability of Task Communications Management. This role has read access to Task Communications Management instance tables such as Communication Plans, Communication Tasks. Users with this role can send impromptu communications.</td>
<td>• Notify_admin&lt;br&gt;• Sn_publications_recipients_list_user&lt;br&gt;Communication Plan Viewer</td>
</tr>
<tr>
<td>Communication Plan Viewer [sn_comm_management.comm_plan_viewer]</td>
<td>This role has read access to Task Communications Management tables.</td>
<td>• Notify_view&lt;br&gt;• Sn_publications_recipients_list_user&lt;br&gt;Communication Plan Viewer</td>
</tr>
<tr>
<td>Communication Plan Manager [sn_comm_management.comm_plan_manager]</td>
<td>This role has create and edit access to Task Communications Management instance tables such as Communication Plans, Communication Tasks. Users with this role can send impromptu communications.</td>
<td></td>
</tr>
</tbody>
</table>

#### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Plan Type Lookup [comm_plan_type_lookup]</td>
<td>Stores the communication plan types.</td>
</tr>
<tr>
<td>Communication Task Type Lookup [comm_task_type_lookup]</td>
<td>Stores the communication task types.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Communication Plan Definition</td>
<td>The definition table for the communication plan entity.</td>
</tr>
<tr>
<td>[comm_plan_definition]</td>
<td></td>
</tr>
<tr>
<td>Communication Task Definition</td>
<td>The definition table for the communication task entity.</td>
</tr>
<tr>
<td>[comm_task_definition]</td>
<td></td>
</tr>
<tr>
<td>Communication Channel Definition</td>
<td>Master table for channel definitions.</td>
</tr>
<tr>
<td>[comm_channel_definition]</td>
<td></td>
</tr>
<tr>
<td>Communication Channel Definition — Email</td>
<td>Defines email as a channel.</td>
</tr>
<tr>
<td>[comm_channel_def_email]</td>
<td></td>
</tr>
<tr>
<td>Communication Channel Definition — SMS</td>
<td>Defines SMS as a channel.</td>
</tr>
<tr>
<td>[comm_channel_def_sms]</td>
<td>Note: This table is available only when you install the Notify plugin (com.snc.notify).</td>
</tr>
<tr>
<td>Communication Channel Definition — Conference</td>
<td>Defines Conference as a channel.</td>
</tr>
<tr>
<td>[comm_channel_def_conference]</td>
<td>Note: This table is available only when the Notify plugin (com.snc.notify) is installed.</td>
</tr>
<tr>
<td>Communication Contact Definition</td>
<td>Defines the contacts for sending out communications. Contacts can be users,</td>
</tr>
<tr>
<td>[comm_contact_definition]</td>
<td>groups, or recipient lists.</td>
</tr>
<tr>
<td>Communication Channel Configuration</td>
<td>Lists all available channels for an instance.</td>
</tr>
<tr>
<td>[comm_channel_config]</td>
<td>Note: Configuration script for each channel is a script include.</td>
</tr>
<tr>
<td>Communication Plan</td>
<td>Stores the communication plan that outlines the communication activity</td>
</tr>
<tr>
<td>[comm_plan]</td>
<td>during an event.</td>
</tr>
<tr>
<td>Communication Task</td>
<td>Stores the task to be carried out to communicate with the involved contacts.</td>
</tr>
<tr>
<td>[comm_task]</td>
<td></td>
</tr>
<tr>
<td>Communication Channel</td>
<td>Master table for channel instances.</td>
</tr>
<tr>
<td>[comm_channel]</td>
<td></td>
</tr>
<tr>
<td>Communication Channel — Email</td>
<td>Stores record that indicate email is used as a communication channel for a</td>
</tr>
<tr>
<td>[comm_channel_email]</td>
<td>communication task.</td>
</tr>
<tr>
<td>Communication Channel — SMS</td>
<td>Stores record that indicate SMS is used as a communication channel for a</td>
</tr>
<tr>
<td>[comm_channel_sms]</td>
<td>communication task.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Install Collaboration Services for Task Communications Management

Install the Collaboration Services for Task Communications Management plugin (sn_tcm_collab_hook) from ServiceNow Store to get the Slack functionality.

**Role required:** admin

1. Navigate to ServiceNow Store.
2. Find the Collaboration Services for Task Communications Management store application.
3. Click the Collaboration Services for Task Communications Management store application and then click Request App.

## Components installed with Collaboration Services for Task Communications Management

Several types of components are installed with the Collaboration Services for Task Communications Management (sn_tcm_collab_hook) plugin, including tables.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Channel Definition – Slack</td>
<td>The table extends the Communication Channel Definition [comm_channel_def] table.</td>
</tr>
<tr>
<td>Communication Channel – Slack</td>
<td>The table extends the Communication Channel [comm_channel] table.</td>
</tr>
<tr>
<td>Communication Plan — Collaboration Service Data</td>
<td>Stores Collaboration Service related data.</td>
</tr>
</tbody>
</table>
Working with Task Communications Management

The section covers topics that help you with a variety of technical concepts related to Task Communications Management such as creating communication plan definition, task definition, channel definition, and contact definition.

Define a communication plan

Define a communication plan for a task record to specify communication task and contact definitions. When specified conditions for the plan definition are met, the communication plan and its associated records are automatically attached to the task record, eliminating manual effort.

Role required: sn_comm_management.comm_plan_admin or admin

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the communication plan.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that the plan is attached to when the conditions are met.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of communication plan such as Technical, Internal, External, Customer.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the communication plans must be associated to the table.</td>
</tr>
<tr>
<td>Condition based</td>
<td>Option to define whether the plan is attached to a table based on the conditions. For example, if you want to attach a communication plan to an incident of priority = 2, you can mention the condition in the Condition field.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to define whether the plan definition is active.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the plan definition.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition under which a communication plan gets attached to a table.</td>
</tr>
</tbody>
</table>

3. Click Submit.
   The communication plan is submitted. The communication plan definition contains the following related lists:
   - Communication Task Definitions
   - Communication Contact Definitions

Define a communication task

Define a communication task for a communication plan. When a plan gets attached to a table, the tasks related to the plan need to be executed to resolve the issue. You can associate multiple tasks with a communication plan.

Role required: sn_comm_management.comm_plan_admin or admin
You have defined a communication plan.

1. Navigate to **Task Communications Management > Plan Definitions**.
2. Click the communication plan that you want to define a communication task for.
3. Click the Communication Task Definitions related list and then click **New**.
4. On the form, fill in the fields.

### Communication Task Definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication plan definition</td>
<td>Unique name of the communication plan definition that you are defining the task for.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name for the communication task definition.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of task, such as internal communication, that is applicable globally or to a particular table.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the task definition. The task definition is available for all applications or for scoped applications.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the communication tasks appear in the plan. This field indicates which communication task to execute first.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to define whether the task is active or not.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the task definition.</td>
</tr>
<tr>
<td>Communication frequency</td>
<td>Frequency of the communication task execution. You can send the notification once or the notification can be repeated.</td>
</tr>
<tr>
<td>Duration</td>
<td>Time by which you want to send a notification. For example, if the communication frequency is <strong>One time</strong> and the <strong>Duration</strong> is 15 minutes, then the notification is sent only once in 15 minutes. If the communication frequency is <strong>Recurring</strong>, then the notification is sent every 15 minutes.</td>
</tr>
</tbody>
</table>

5. Click **Update**.
   The communication task is defined for the communication plan.

Define communication channel for the task.

### Define a communication channel

Define a communication channel for each communication task to determine which mode of communication to use for the task when a plan is attached to a table.

Role required: sn_comm_management.comm_plan_admin or admin

You have defined a communication plan and its related tasks.

- The modes of communication available are: email, SMS, conference, and Slack.
- For the incident table, the functionality for SMS and conference appears only if you activate the Notify plugin (com.snc.notify) and the **com.snc.iam.notify_number** property value is set to the registered notify number. The notify number is registered while configuring the Twilio account.
• For the incident table, the functionality for Slack appears only if you activate the Collaboration Services for Task Communications Management plugin (sn_tcm_collab_hook). To activate the Collaboration Services for Task Communications Management plugin, navigate to ServiceNow Store and install the Collaboration Services for Task Communications Management application. For more information, refer to Collaboration Services for Task Communications Management.

**Note:** For information on how to configure Slack, refer to Configure Slack workspace.

• **Add Channel – Conference** is mutually exclusive to **Add Channel – SMS** and **Add Channel – Email**. If you select **Add Channel – Conference**, you cannot select **Add Channel – Email** or **Add Channel – SMS**.

1. Navigate to Task Communications Management > Plan Definitions.
2. Click a communication plan.
3. Click the Communication Task Definitions related list and then click the task that you want to define the communication channel for.
4. On the Communication Task Definition form, click any one of the following related links based on your requirement:
   - **Add Channel – Conference**
   - **Add Channel – Email**
   - **Add Channel – SMS**
   - **Add Channel – Slack**
5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Communication Channel Definition form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Add Channel – Conference</td>
</tr>
<tr>
<td>Communication task definition</td>
</tr>
<tr>
<td>Notify provider selector</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Add Channel – Email

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication task definition</td>
<td>Communication task definition that this channel definition is associated with.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email client template</td>
<td>Lookup icon (🔍) to select the email client template used to send emails to the targeted audience.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This email template must be defined in the Communication task table.</td>
</tr>
<tr>
<td>Add Channel – SMS</td>
<td></td>
</tr>
<tr>
<td>Communication task definition</td>
<td>Communication task definition this channel definition is associated with.</td>
</tr>
<tr>
<td>Notify SMS template</td>
<td>Lookup icon (🔍) to select the notify SMS template used to send an SMS to the targeted audience.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This SMS template must be defined in the Communication task table.</td>
</tr>
<tr>
<td>Notify provider selector</td>
<td>Lookup icon (🔍) to select the selector from the Provider Selector [notify_group_selector] table.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The selector can be associated with notify number group or conference provider. Each notify number group can have one or more Notify numbers that can be used to send SMS.</td>
</tr>
<tr>
<td>Add Channel – Slack</td>
<td></td>
</tr>
<tr>
<td>Communication task definition</td>
<td>Communication task definition this channel definition is associated with.</td>
</tr>
<tr>
<td>Channel Type</td>
<td>Channel type is Slack.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.
A communication channel is defined for the communication task.

After creating communication tasks and communication channels for those tasks, define contacts for the communication plan.

**Define a communication contact**

Define the recipients of a particular plan to determine the target audience involved in each communication task and the responsibilities the recipients are expected to handle. A notification for a task is sent to all individuals specified for that task.

Role required: sn_comm_management.communication_plan_admin or admin

You have defined a communication plan.
You can add or remove any particular communication contact manually.

1. Navigate to **Task Communications Management > Plan Definitions**.
2. Click the communication plan that you want to define the contacts for.
3. Click the **Communication Contact Definitions** related list and then click **New**.
4. On the form, fill in the fields.

**Communication Contact Definition form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Type of contact such as user, group, or recipient list that you want to involve in the plan. The contact type is assigned dynamically at the time of the table execution.</td>
</tr>
<tr>
<td>Responsibility</td>
<td>Responsibility that the user, group, or individuals in the recipient list are expected to handle.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user, group, or recipient list to be added to the contact list.</td>
</tr>
</tbody>
</table>

**Note:** You can use the recipient list to specify dynamic criteria for fetching the list of users for a particular communication plan.

5. Click **Submit**.
A communication contact is defined for the communication plan.

### Define a recipient list for communication contact

A recipient list lets you specify a filter to fetch a list of users. Use the recipient list as the contact for a particular communication plan.

**Role required:** sn_comm_management.comm_plan_admin or admin

Sometimes, the contacts that you want to include in a plan can only be known dynamically. For example, you might want the support group associated with a particular business service in an incident to be involved in the communication plan. The support group might change depending on the business service that you select. In such a case, a recipient list provides the flexibility to add recipients dynamically.

1. Navigate to **Task Communications Management > Administration > Recipients Lists**, and click **New**.
2. On the form, fill in the fields.

**Recipients Lists form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the recipient list.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of recipient.</td>
</tr>
<tr>
<td>State</td>
<td>[Read only] The state of the recipient list.</td>
</tr>
<tr>
<td>Setup</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Method</td>
<td>The method used to generate the recipient list.</td>
</tr>
<tr>
<td></td>
<td>• Upload File: Upload an Excel file with the recipient information to create a recipient list. This list is static.</td>
</tr>
<tr>
<td></td>
<td>• Dynamic Condition: Use scripts or conditions to receive recipient information.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

A recipient list is defined for the contact.

Define a communication contact for the task.

**Create a plan type**

Create the communication plan type and specify whether the plan type is applicable globally or to a particular table. When you create the communication plan type, it is referenced in the communication plan definition. The type of the communication plan helps you to filter the plan by its type, generate a report of a particular plan type, or create SLAs for any communication plan.

Role required: sn_comm_management.comm_plan_admin or admin

1. Navigate to **Task Communication Management > Administration > Plan Types**, and click **New**.

2. On the form, fill in the fields.

**Communication Plan Type Lookup form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the communication plan type.</td>
</tr>
<tr>
<td>Global</td>
<td>Option to determine whether the plan type is available for all tables or for a specific table. If the check box is not selected, the Table field appears where you can select the table for which the plan type appears.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the plan type. The plan type is available for all applications or for scoped applications.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to define whether the plan type is active.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the plan type.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

A communication plan type is created.

Define a communication plan.

**Create a task type**

Create the communication task type and specify whether the task is applicable to a particular table or is globally applicable. The communication task type helps you to filter a task by its type, generate a report of a particular task type, or create SLAs for any communication task.

Role required: sn_comm_management.comm_plan_admin

1. Navigate to **Task Communication Management > Administration > Task Types**, and click **New**.
2. On the form, fill in the fields.

**Communication Task Type Lookup form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the communication task type.</td>
</tr>
<tr>
<td>Global</td>
<td>Option to determine whether the task type is available for all tables or for a specific table. If the check box is not selected, the <strong>Table</strong> field appears where you can select the table the task type appears for.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the task type. The task type is available for all applications or for scoped applications.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to define whether the task type is active or not.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description regarding the type of the task.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
A communication task type is created.

Define a communication task.

**Define contact responsibilities**

Define the different contacts or target audience involved in the communication process and their responsibility to understand the expectations from those contacts throughout the process.

Role required: sn_comm_management.comm_plan_admin or admin

1. Navigate to **Task Communication Management > Administration > Contact Responsibilities**, and click **New**.
2. On the form, fill in the fields.

**Contact Responsibility form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Option to determine whether the contact responsibility is available for all tables or for a specific table. If the check box is not selected, the <strong>Table</strong> field appears where you can select the table that you are defining the contact responsibility for.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name of the contact, such as Business Director or Communication Manager, involved in the communication process.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of contact such as user, group, or recipient list.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that the contact is activated on when a communication plan is attached.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
Contact responsibilities are defined.

Define a communication contact for the task.
View communication channel configuration

View the configuration of different communication channels that are used to contact the target audience in the communication process. By default, the communication channels available are email, SMS, Slack, and conference.

Role required: sn_comm_management.comm_plan_admin or admin

You only have read access to the Channel Configuration module. If you want to create a new channel configuration, request the channel configuration through the HI Customer Service system.

1. Navigate to **Task Communication Management > Administration > Channel Configuration**.
2. Open any communication channel record.
3. On the form, view the fields.

**Communication Channel Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>[Read only] Mode of channel.</td>
</tr>
<tr>
<td>Configuration script</td>
<td>[Read only] Lookup icon ( ) to select the script that defines the channel configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>[Read only] Option to define whether the communication channel is active or not.</td>
</tr>
<tr>
<td>Classification</td>
<td>[Read only] Internally used to group the channels between conference or major incident management workbench.</td>
</tr>
</tbody>
</table>

Configure Slack for a communication task

Configure Slack as a mode of communication for a communication task to send direct message to the users.

Role required: sn_comm_management.comm_plan_admin or admin

Install the Collaboration Services for Task Communications Management plugin (sn_tcm_collab_hook) from ServiceNow Store.

1. Navigate to **Incident > Communication Plan Definitions**.
2. Open the communication plan where you want to add Slack as a communication channel for a communication task.
3. Open the communication task definition for which you want to add Slack as the mode of communication.
4. Click the **Add Channel – Slack** related links.
5. Click **Submit**.

Slack gets added as a communication channel for the communication task.

Timeline Visualizations

A timeline visualization is a representation of an organization's activities over time.

Typically, timeline visualizations are useful for quickly assessing the impact of future strategic and operational activities such as change requests and projects. Timeline visualizations come in two varieties:
a two-dimensional (2D) view where activities are grouped by month, and a three-dimensional (3D) view where activities are grouped in lanes. Both views are interactive, and the 2D view can be printed.

Timeline administrators, users with the timeline_admin role, can set up visualizations to represent ITSM-related activities, such as incidents, problems, changes, and projects. Timeline administrators or users with the timeline_user role can personalize their timeline visualizations from the Settings pane in the visualization.

The CIO Roadmap timeline visualization shows your organization's projects grouped by portfolios. Organizational leaders can use the CIO Roadmap to monitor and evaluate the status of current and upcoming projects.

**Note:** Activating timeline visualizations does not activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

**Key terms for timeline visualizations**

- **Lane**: A logical grouping of items on the 3D timeline visualization. For example, one lane might show pending projects while another lane shows open projects.
- **Panel**: A block that represents an item record in a 2D timeline visualization, or a block that represents one or more item records in a 3D timeline visualization.
- **Summary view**: A pop-up window that appears when a user clicks a panel in either the 2D or 3D timeline visualization. The summary view contains additional information about the record. Timeline administrators configure the information that appears in the summary view.
- **Marker**: A bar indicating the start of a month in a 3D timeline visualization.
- **Slider**: A tool used to control the time period seen in a 3D visualization.
- **Slider track**: An alternative view of the panels displayed in both the 2D and 3D timeline visualization.
<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Meeting Rooms</td>
<td>Mar 14, 2014</td>
<td>Apr 1, 2014</td>
<td>May 18, 2014</td>
<td>Jun 18, 2014</td>
</tr>
<tr>
<td>Operations Quarterly Review</td>
<td>Apr 1, 2014</td>
<td>May 1, 2014</td>
<td>Jun 1, 2014</td>
<td>Jul 1, 2014</td>
</tr>
<tr>
<td>SSO Kenban Adoption</td>
<td>Jul 1, 2014</td>
<td>Jul 1, 2014</td>
<td>Jul 1, 2014</td>
<td>Jul 1, 2014</td>
</tr>
<tr>
<td>HCM Enhancement Project</td>
<td>Jul 1, 2014</td>
<td>Jul 1, 2014</td>
<td>Jul 1, 2014</td>
<td>Jul 1, 2014</td>
</tr>
<tr>
<td>IPC Reporting</td>
<td>Jul 1, 2014</td>
<td>Jul 1, 2014</td>
<td>Jul 1, 2014</td>
<td>Jul 1, 2014</td>
</tr>
</tbody>
</table>

**Navigation Arrows**

**Settings Pane Tab**

**Slider Track**
Activate Timeline Visualization

An administrator can activate the Timeline Visualization plugin (com.snc.timeline_visualization) to access the functionality.

To use the CIO roadmap with timeline visualization, you must activate Project Portfolio Management (com.snc.financial_planning_pmo) plugin.

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: **Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>**.

Installed with Timeline Visualizations

Several components are installed with timeline visualizations.
Tables

Timeline visualization adds the following table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeline Visualization [roadmap_page]</td>
<td>Stores all available timeline visualizations.</td>
</tr>
<tr>
<td>Personalize Timeline [roadmap_user_page]</td>
<td>Stores timeline personalization settings for all timeline visualizations.</td>
</tr>
</tbody>
</table>

UI Policies

Timeline visualization adds the following UI policy.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Timeline Visualization configuration Page to enable/disable certain fields</td>
<td>Timeline Visualization [roadmap_page]</td>
<td>Script that hides fields in the Timeline Visualization form when the form loads.</td>
</tr>
</tbody>
</table>

Script Includes

Timeline visualization adds the following script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roadmap2DUtil</td>
<td>Timeline Visualization - 2D API to generate data for lanes and panels.</td>
</tr>
<tr>
<td>RoadmapCommonUtil</td>
<td>Timeline visualization common utility to handle generic functions.</td>
</tr>
<tr>
<td>RoadmapConfig</td>
<td>Timeline visualization utility allowing configuration through the Timeline Visualization [roadmap_page] table.</td>
</tr>
<tr>
<td>RoadmapItems</td>
<td>Timeline visualization utility to get lane items.</td>
</tr>
<tr>
<td>RoadmapUtil</td>
<td>API to generate data for lanes and panels.</td>
</tr>
</tbody>
</table>

Client Scripts

Timeline visualization adds the following client scripts.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roadmap Color Choice</td>
<td>Timeline Visualization [roadmap_page]</td>
<td>Sets color values for the color choice fields in the timeline visualization configuration page.</td>
</tr>
<tr>
<td>Roadmap Item Table</td>
<td>Timeline Visualization [roadmap_page]</td>
<td>Allows changing the color fields for the item_color_key whenever there is a change to the panel table.</td>
</tr>
</tbody>
</table>
### Business Rules

Timeline visualization adds the following business rule.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check only one default</td>
<td>Timeline Visualization</td>
<td>Checks if another visualization is already set as default when user sets</td>
</tr>
<tr>
<td></td>
<td>[roadmap_page]</td>
<td>a new visualization as the default.</td>
</tr>
</tbody>
</table>

### Timeline visualizations roles

Timeline visualizations provides two roles.

#### Roles

<table>
<thead>
<tr>
<th>Role Title [Name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeline administrator [timeline_admin]</td>
<td>Create and edit timeline visualization pages and view timeline visualizations.</td>
</tr>
<tr>
<td>Timeline user [timeline_user]</td>
<td>View timeline visualizations. Timeline user access is also granted to users with the project_manager and project_user roles.</td>
</tr>
</tbody>
</table>

### Create a Timeline Visualization

Set up timeline visualizations for the organization's leaders by creating a timeline that provides visual representations of the organization's operational and strategic activities.

Role required: timeline_admin

Additionally, create timeline visualization views to define what data appears in the summary window when a user clicks a panel on the timeline.

**Note:** Activating timeline visualizations doesn't activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.
• Navigate to **Timeline Visualization > Create New** and create a new record.
Timeline visualization configuration form
# Timeline visualization configuration form field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the visualization.</td>
</tr>
<tr>
<td>Panel table</td>
<td>Table that provides the records displayed as lanes and panels in the timeline.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The list shows only tables and database views that are in the same scope as the visualization.</td>
</tr>
<tr>
<td>Relationship field</td>
<td>Field on the table that contains values displayed as lane titles. Typically this field is a reference field or a field that contains a limited range of values.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The CIO Roadmap timeline visualization is a ServiceNow customized visualization for the Project application that does not use the Relationship field.</td>
</tr>
<tr>
<td>Show slider</td>
<td>Check box that enables (selected) or disables (cleared) displaying the timeline slider that users move to change the dates shown.</td>
</tr>
<tr>
<td>Panel name</td>
<td>Field from the Panel table that contains the values displayed in the panel body.</td>
</tr>
<tr>
<td>Panel date</td>
<td>Field from the Panel table that contains the date values displayed in the panel head in 3D view and in the panel body in 2D view. These dates also determine placement of panels on a lane. Only date and date-time fields are available on the choice list.</td>
</tr>
<tr>
<td>Default</td>
<td>Check box that sets (selected) or removes (cleared) the default status of a visualization when you have more than one defined for a specific table. Applications that include a visualization use the default visualization.</td>
</tr>
<tr>
<td>Max items per lane</td>
<td>Maximum number of items that are displayed in a lane in 3D view. The default value is 500.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The field is not visible on the form by default. Configure the form to add this field.</td>
</tr>
</tbody>
</table>
## ServiceNow DocVersion

### Now Platform capabilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max items per lane 2d</td>
<td>Maximum number of items that are displayed in a lane in 2D view. The default value is 99.</td>
</tr>
</tbody>
</table>

**Note:** The field is not visible on the form by default. Configure the form to add this field.

---

### Timeline visualization configuration filtering and sorting form field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lane condition</td>
<td>Condition builder used to create filters and apply sorting to values that are used as lanes in 3D view visualizations. For example, if you set [Name] [is not] [IT] as a lane condition for the CIO Roadmap, then IT no longer appears as a lane in the roadmap, nor does it appear as a lane option in the Settings pane. Removing the filter restores the IT lane to the visualization and to lane options in the Settings pane. To order the results, specify sorting based on relevant field names. For example, to order the portfolio names so that they appear in reverse alphabetical order on the CIO Roadmap, set the sort fields to [Name] [z to a].</td>
</tr>
<tr>
<td>Panel condition</td>
<td>Condition builder used to create filters and apply sorting to values that are used as panels in 2D and 3D view visualizations. For example, if you set [State] [is one of] [Pending, Open, Work in Progress] as the panel condition for the CIO Roadmap, only projects that are in one of those states appear on the roadmap.</td>
</tr>
</tbody>
</table>

### Timeline visualization configuration color options form field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel color key</td>
<td>Field from the Panel table that contains values used for color coding the information displayed. The field selected here determines the values that are available in the Label fields on the form. The CIO Roadmap uses State, which is a field in the Project table. Panels on the CIO Roadmap are color coded according to the project state, which can be Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Skipped.</td>
</tr>
</tbody>
</table>

**Note:** You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap. Examples of other fields that are suitable for this selection include Priority, Risk, and Approval.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label 1</td>
<td>Values to be color coded. The values available are determined by the Panel color key field. For example, the CIO Roadmap is based on the Project table and has the Panel color key set to the State field, which contains the values Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped. You can set specific colors for up to four values from the selected field. Other values are shown in the Default color.</td>
</tr>
<tr>
<td>Label 2</td>
<td></td>
</tr>
<tr>
<td>Label 3</td>
<td></td>
</tr>
<tr>
<td>Label 4</td>
<td></td>
</tr>
<tr>
<td>Default color</td>
<td>Color applied to values that are not selected for labels. For example, the CIO Roadmap color codes and creates labels for the values Pending, Open, Work in Progress, and Closed Complete. The additional values, Closed Incomplete and Closed Skipped, use the default color.</td>
</tr>
<tr>
<td>Color 1</td>
<td>Colors that correspond to each of the Label field values. For example, if Label 1 is the Pending state, and Color 1 is red, then panels for projects in the pending state are red.</td>
</tr>
<tr>
<td>Color 2</td>
<td></td>
</tr>
<tr>
<td>Color 3</td>
<td></td>
</tr>
<tr>
<td>Color 4</td>
<td></td>
</tr>
</tbody>
</table>

### Create a Timeline Visualization view

The timeline visualization view determines which record details appear in the pop-up summary window when a user clicks a panel.

You can create one timeline visualization view per table. For example, if your view shows incident records, you can create a view on the Incident table to show only certain information, such as the incident number, priority, and short description.

If no Timeline Visualization view exists, all panels use the default view that shows all the fields that currently appear on the default view of the form for that table. After you create a Timeline Visualization view for a table, all panels then use that view.

For example, to create a Timeline Visualization view using the Incident form:

1. Navigate to Incident > All.
2. Open an incident.
3. Right-click the form header and select Configure > Form Layout.
4. Under Form view and section, go to the View name field and select New.
5. Enter timeline visualization in the View name field.
6. Click Ok to create the timeline visualization view.
7. Add fields to or remove items from the timeline visualization view using the Available and Selected columns.
8. Click Save.
Planning Your Timeline Visualization

Before creating a timeline visualization, you should have a clear idea of the information that you want to display.

This planning process helps you identify the required table and fields, and determine filtering and sorting requirements. Since users can personalize the visualization, avoid setting restrictive filters that may prevent users from finding categories that they are accustomed to seeing. You can use the CIO Roadmap as a starting point for creating your own timeline visualizations.

Note: Activating timeline visualizations doesn't activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

Use Timeline Visualization

Timeline Visualization provides a high-level view of an organization's strategic and operational activities over time.

Organizational decision makers can use the information in visualizations for activities such as planning future projects and estimating resource requirements. Users can personalize the information displayed with the visualization Settings pane.

Activating the Timeline Visualization application does not install the CIO Roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap. CIO Roadmap is a timeline visualization that displays an organization's IT projects and portfolios. This following sections use the CIO Roadmap to demonstrate features of timeline visualizations.

Lanes, markers, and panels

Lanes, markers, and panels are the fundamental elements of a timeline visualization. appear in the 3D view only.

Note: Lanes and markers are available in the 3D view only. A panel in the 2D view always represents a single record, while panels in 3D view may represent one or more records.

Lanes

A lane is a channel in which activities are grouped. A visualization can display up to eight lanes at a time. While viewing a visualization, you can use the Settings pane to show or hide individual lanes.

Note: The number of items displayed in a lane depends on the Max items per lane and Max items per lane 2d settings on Timeline Visualization form.

Markers

Markers are horizontal lines that cross all lanes and identify a transition to the next month.

Panels

Panels in both 2D and 3D views are color coded according to values that the administrator selects during the initial setup.
In 2D view, panels are grouped by month and stacked in chronological order, from the earliest date to the latest date. By default, the 2D view opens with the current month displayed on the left side of the visualization. You can print visualizations from the 2D view using the browser’s print option. In 3D view, panels are grouped in lanes and ordered by date, from earliest to latest. The date that appears on the panel determines its placement in 2D and 3D view. The date displayed is based on a value the timeline administrator selects during initial setup.

Panels appear in the CIO Roadmap according to the planned completion date for the project. In 3D view, projects with the same planned date of completion are consolidated into a single panel. In 2D view, projects with the same planned date of completion are displayed as individual panels.

Panel headers in the CIO Roadmap are color coded based on project state. However, in 3D view, if a panel represents more than one project, the panel header is colored black. The Settings pane contains a key showing each available project state and the corresponding color.

Note: Activating timeline visualizations doesn’t activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

To view additional information about a panel:

- Click a panel for a single record while in 2D or 3D view to open a summary window that contains additional information. Click the heading in the summary window to open the full record.
- Click a panel that represents multiple records to open a list of those records. Click a record number to open the full record.

The timeline administrator can configure the information that appears in summary windows.

**Personalize Timeline Visualizations**

You can configure settings for timeline visualizations like lane and panel conditions, colors, and labels.

**Personalization**

Open the Settings pane and click **Configure**. Complete the form as appropriate (see table).
Visualization personalization

Timeline visualization personalization form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lane conditions</td>
<td>Condition builder used to create filters and apply sorting to values that are used as lanes in 3D view visualizations. For example, if you set [Name] [is not] [IT] as a lane condition for the CIO Roadmap, then IT no longer appears as a lane in the roadmap, nor does it appear as a lane option in the Settings pane. Removing the filter restores the IT lane to the visualization and to lane options in the Settings pane. To order the results, specify sorting based on relevant field names. For example, to order the portfolio names so that they appear in reverse alphabetical order on the CIO Roadmap, set the sort fields to [Name] [z to a].</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Panel conditions</td>
<td>Condition builder used to create filters and apply sorting to values that are used as panels in the visualization. For example, if you set [State] [is one of] [Pending, Open, Work in Progress] as the panel condition for the CIO Roadmap, only projects that are in one of those states appear on the roadmap.</td>
</tr>
<tr>
<td>Panel color key</td>
<td>Field from the Panel table that contains values used for color coding the information displayed. The field selected here determines the values that are available in the Label fields on the form. The CIO Roadmap uses State, which is a field in the Project table. Panels on the CIO Roadmap are color coded according to the project state, which can be Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Skipped. Examples of other fields that are suitable for this selection include Priority, Risk, and Approval.</td>
</tr>
<tr>
<td>Label 1, Label 2, Label 3, Label 4</td>
<td>Values to be color coded. The values available are determined by the Panel color key field. For example, the CIO Roadmap is based on the Project table and has the Panel color key set to the State field, which contains the values Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped. You can set specific colors for up to four values from the selected field. Other values are shown in the Default color.</td>
</tr>
<tr>
<td>Default color</td>
<td>Color applied to values that are not selected for labels. For example, the CIO Roadmap color codes and creates labels for the values Pending, Open, Work in Progress, and Closed Complete. The additional values, Closed Incomplete and Closed Skipped, use the default color.</td>
</tr>
<tr>
<td>Color 1, Color 2, Color 3, Color 4</td>
<td>Colors that correspond to each of the Label field values. For example, if Label 1 is the Pending state, and Color 1 is red, then panels for projects in the pending state are red.</td>
</tr>
</tbody>
</table>

**Note:**
- Activating timeline visualizations doesn’t activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.
- If the Max items per lane field is set to more than 1000, you may observe a delay when displaying the timeline data using Internet Explorer (IE) as the browser.
The Settings pane

Element names in the Settings pane vary based on the table and fields used to create the visualization.

The Settings pane contains the following elements:
Settings pane elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>Identifies the type of information that is color coded on the timeline, such as state or priority. It also lists the color assigned to each possible value, such as pending state and open state.</td>
</tr>
<tr>
<td>Configure</td>
<td>Allows you to personalize a visualization by creating filters on lane information and panel information, specifying sort order for results, and reassigning panel colors. These changes affect your view of the visualization only.</td>
</tr>
<tr>
<td>View</td>
<td>Allows you to switch between 2D and 3D view.</td>
</tr>
<tr>
<td>View &lt;table&gt; List</td>
<td>Opens a separate browser tab showing the complete record list for the associated table.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Allows you to click lane names to add or remove them from the visualization. While the visualization is in 2D view, the Settings pane displays a Show all &lt;records&gt; button that allows you to override lane filters applied to the initial setup.</td>
</tr>
</tbody>
</table>

Use the slider and slider track

The slider and slider track are useful for quickly navigating to any point in time on a visualization.

**Note:** Activating timeline visualizations doesn’t activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

For the CIO Roadmap, the slider track allows you to quickly view the distribution of projects over time and determine project states. While in 3D view, click and drag the slider to move the timeline forward or backward. In 2D view, click and drag the slider track right or left to move the timeline forward or backward.

The slider track provides an alternative view of panels on a visualization. For the CIO Roadmap, a colored dot in the slider track indicates the presence of one or more projects for a given day. The different dot colors correspond to different project states. This allows you to scan the slider track to identify projects of interest by their color, and then use the slider or slider track to quickly navigate to those projects. For example, if you are interested in projects that are in a pending state, you can use the slider to navigate to the colored dots that represent that state.

**Note:** Dots in the slider track do not correspond one-to-one with panels in a visualization. A dot represents the presence of one or more projects on a given date. In 3D view, if there is more than one project for a given day, all of the projects for that day are combined into a single panel on the roadmap. When the slider track is populated, projects in a multi project panel are analyzed for project state and then represented as appropriately colored dots in the slider track.

Similarly, you can use the slider or slider track in conjunction with the calendar to quickly navigate to any point in time. For example, if you are concerned about resource issues in April 2014 because you see a large cluster of dots during that time, dragging the slider or slider track to those dots brings those projects into view. Click the individual panels to view additional information.
View timeline visualization

You can view timeline visualizations from a project.

1. Navigate to **Project > Projects > All**.
2. Scroll to the bottom of the list and click the **Timeline Visualization** related link.

By default, the CIO Roadmap opens in three-dimensional (3D) view with the current date at the forefront of the timeline. You can use the Settings pane to change between two-dimensional (2D) and 3D view. As soon as you view a timeline visualization, it is considered personalized. After that, you see your personalized view even if the timeline administrator makes changes to the default visualization.

**Note:** Activating timeline visualizations doesn’t activate predefined CIO roadmap. You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

Timeline administrators can create timeline visualizations on other tables. If you are not sure whether a timeline visualization exists for a certain application, use the application navigator to open the application of your choice, and click **All**. If a timeline visualization exists for the application's table, a Timeline Visualization related link appears.

Work with timeline visualizations

There are various tools that allow you to move visualizations backward and forward in time depending on whether you are in 2D or 3D view.

The following options are available for navigating between months.

**2D views**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragging</td>
<td>Hold down the left mouse button and drag the slider track right or left to view other months.</td>
</tr>
<tr>
<td>Left and right arrow keys</td>
<td>Press the left or right arrow keys on the keyboard to move the timeline forward or backward.</td>
</tr>
<tr>
<td>Mouse wheel button</td>
<td>Scroll the wheel to move the timeline forward or backward.</td>
</tr>
<tr>
<td>Right and left navigation arrows</td>
<td>Click the arrows to move from month to month. Arrows do not appear if there are no additional months to view.</td>
</tr>
</tbody>
</table>

The following options are available for navigating stacked panels.

**Navigating stacked panels**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragging</td>
<td>Hold down the left mouse button and drag the stack up or down to view other panels.</td>
</tr>
<tr>
<td>Up and down navigation arrows</td>
<td>Click the arrows in a stack to view additional panels for the same month. Arrows do not appear if there are no additional panels to view.</td>
</tr>
</tbody>
</table>
The following options are available for navigating in 3D view.

### 3D view

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragging</td>
<td>Hold down the left mouse button and drag the slider along the slider track to move the timeline forward or backward.</td>
</tr>
<tr>
<td>Mouse wheel button</td>
<td>Scroll the wheel to move the timeline forward or backward.</td>
</tr>
<tr>
<td>Up and down arrow keys</td>
<td>Press the arrow keys to move the timeline forward or backward.</td>
</tr>
</tbody>
</table>

---

### Visual Task Boards

Visual Task Boards (VTB) transform the navigation of lists and forms into an interactive graphical experience.

With Visual Task Boards, you can view and update multiple task records, which appear as cards that can be moved between lanes. An activity stream on the board displays recent activity so you can easily track changes to tasks. You can add task cards from any table that extends Task to intuitively and easily track updates and edit records directly from the board. Any user can use task boards, regardless of role, though access control rules (ACLS) may limit which cards each user can see. The Visual Task Board interface provides a graphic-rich environment suited for managing and collaborating on records. For example, a support manager might create a board for her team to track their assigned incidents by state in real time.

This video demonstrates how Visual Task Boards work.

**Note:** UI16 or UI15 is required to use Visual Task Boards.

Visual task boards have domain separation at the data level only. For more information, see Domain separation in Visual Task Boards.

The following podcast offers additional information on the use of Visual Task Boards.

- **Explore**
  - Upgrade to New York
  - Task board structure
  - Domain separation in Visual Task Boards

- **Set up**
  - Activate Visual Task Boards
  - Supported browsers for Visual Task Boards

- **Administer**
  - Configure a task board
  - Configure Visual Task Boards labels
  - Configure the task board card view

- **Use**
  - Create a freeform board
  - Create a data driven board
  - Task cards

- **Develop**
  - Developer training
  - Developer documentation
  - Installed with Visual Task Boards

- **Troubleshoot and get help**
  - Ask or answer questions in the Visual Task Boards forum
  - Search the HI Knowledge Base for known error articles
  - Contact ServiceNow Technical Support

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Activate Visual Task Boards

Visual Task Boards are active by default on new instances. For upgraded instances, you can activate the Visual Task Boards plugin [com.glide.ui.vtb] if you have the admin role.

Role required: admin

For plugin activation steps, see Activate a plugin.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Domain separation in Visual Task Boards

This is an overview of domain separation in the Visual Task Boards application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Support: Data only

Domain separation in this application is supported at the Data only level, meaning it supports the data security model of separating visibility of data from one domain to another. To learn more, see Application support for domain separation.

Installed with Visual Task Boards

Several types of components are installed with Visual Task Boards.

Tables installed with Visual Task Boards

Tables are added with activation of Visual Task Boards.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Board Member</td>
<td>Stores a record for each member of each task board.</td>
</tr>
<tr>
<td>[vtb_board_member]</td>
<td></td>
</tr>
<tr>
<td>Private Task</td>
<td>Stores a record for each personal task on each freeform board.</td>
</tr>
<tr>
<td>[vtb_task]</td>
<td></td>
</tr>
<tr>
<td>Visual Task Board</td>
<td>Stores a record for each task board.</td>
</tr>
<tr>
<td>[vtb_board]</td>
<td></td>
</tr>
</tbody>
</table>
### Properties installed with Visual Task Boards

Properties are added with activation of Visual Task Boards.

**Note:** To open the System Property [sys_properties] table, enter `sys_properties.list` in the navigation filter.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vtb.board.upload_limit</td>
<td>Sets the maximum file size in megabytes allowed for each task card attachment.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 10</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> System Property [sys_properties] table</td>
</tr>
</tbody>
</table>

### Script includes installed with Visual Task Boards

Script includes are added with activation of Visual Task Boards.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VisualTaskBoards</td>
<td>Provides general utilities for Visual Task Boards.</td>
</tr>
<tr>
<td>VTBBoardSecurity</td>
<td>Provides security utilities to control board access.</td>
</tr>
<tr>
<td>VTBGetBoardsByUser</td>
<td>Provides a method that retrieves all the boards a specified user owns or is a member of.</td>
</tr>
<tr>
<td>VTBTaskSecurity</td>
<td>Provides security utilities to control task access.</td>
</tr>
</tbody>
</table>

### Client scripts installed with Visual Task Boards

Client scripts are added with activation of Visual Task Boards.
## Business rules installed with Visual Task Boards

Business rules are added with activation of Visual Task Boards.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add members to live group</td>
<td>Board Member</td>
<td>If a Connect Chat conversation is created for a task board, this business rule adds the board members as conversation members.</td>
</tr>
<tr>
<td></td>
<td>[vtb_board_member]</td>
<td></td>
</tr>
<tr>
<td>Remove member from live group</td>
<td>Board Member</td>
<td>If a Connect Chat conversation exists for a task board and a user is removed from the board members, this business rule removes the user from the conversation members.</td>
</tr>
<tr>
<td></td>
<td>[vtb_board_member]</td>
<td></td>
</tr>
<tr>
<td>Remove member from VTB</td>
<td>Live Group Member</td>
<td>If a Connect Chat conversation exists for a task board and a user is removed from the conversation members, this business rule removes the user from the task board members.</td>
</tr>
<tr>
<td></td>
<td>[live_group_member]</td>
<td></td>
</tr>
<tr>
<td>Sync board name to Connect</td>
<td>Visual Task Board</td>
<td>If a Connect Chat conversation exists for a task board and someone updates the board name, this business rule updates the conversation name.</td>
</tr>
<tr>
<td></td>
<td>[vtb_board]</td>
<td></td>
</tr>
<tr>
<td>Sync chat name to VTB board</td>
<td>Live Group Profile</td>
<td>If a Connect Chat conversation exists for a task board and someone updates the conversation name, this business rule updates the board name.</td>
</tr>
<tr>
<td></td>
<td>[live_group_profile]</td>
<td></td>
</tr>
<tr>
<td>Sync Members With VTB</td>
<td>Live Group Member</td>
<td>If a Connect Chat conversation exists for a task board and a user is added to the conversation members, this business rule adds the user as a board member.</td>
</tr>
<tr>
<td></td>
<td>[live_group_member]</td>
<td></td>
</tr>
<tr>
<td>Update Board on Card Change</td>
<td>Visual Task Board Card</td>
<td>Triggers the system to update the task board when changes occur to the cards.</td>
</tr>
<tr>
<td></td>
<td>[vtb_card]</td>
<td></td>
</tr>
<tr>
<td>Update Board on Lane Change</td>
<td>Visual Task Board Lane</td>
<td>Triggers the system to update the task board when changes occur to the lanes.</td>
</tr>
<tr>
<td></td>
<td>[vtb_lane]</td>
<td></td>
</tr>
</tbody>
</table>
### Business rule

<table>
<thead>
<tr>
<th>Description</th>
<th>Table</th>
<th>Table Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>update board on lane change</td>
<td>Board Member</td>
<td>Triggers the system to update the task board when changes occur to the board members.</td>
</tr>
<tr>
<td>VTB Previous Additional Assignees</td>
<td>Private Task</td>
<td>Triggers the system to send an email notification to users when they are designated as additional assignees for cards.</td>
</tr>
</tbody>
</table>

### Notifications installed with Visual Task Boards

Notifications are added with activation of Visual Task Boards.

<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VTB member addition notification</td>
<td>Sends an email notification to the member about their addition to the board.</td>
</tr>
<tr>
<td>VTB member deletion notification</td>
<td>Sends an email notification to the member about their removal from the board.</td>
</tr>
<tr>
<td>VTB additional assignee notification</td>
<td>Sends an email notification to users when they are designated as additional assignees for tasks.</td>
</tr>
<tr>
<td>VTB assignee notification</td>
<td>Sends an email notification to users when they are designated as the primary assignees for tasks.</td>
</tr>
<tr>
<td>VTB lane change notification</td>
<td>Sends an email notification to a task’s assignees when the task changes lanes.</td>
</tr>
<tr>
<td>VTB lane limit reached</td>
<td>Sends an email notification to the board member that the number of tasks in the lane has reached the set lane limit.</td>
</tr>
<tr>
<td>VTB lane limit exceeded</td>
<td>Sends an email notification to the board member that the number of tasks in the lane has exceeded the set lane limit.</td>
</tr>
<tr>
<td>VTB card movement across vertical lanes and swimlanes</td>
<td>Sends an email notification to the board member with the details of the card moved and the member who moved the card.</td>
</tr>
</tbody>
</table>

### Supported browsers for Visual Task Boards

The system supports Visual Task Boards on most modern browsers.

### Supported browsers

- The latest public release of Firefox or Firefox ESR
- The latest public release of Chrome
- Safari version 12
• Internet Explorer version 11
  • Edge mode is supported.
  • Compatibility mode is not supported.
  • Setting Security Mode to High (via the Internet Options > Security tab) is not supported.
  • Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7.

  **Note:** VTB loading is comparatively slower on Internet Explorer 11 browsers

The recommended limit to include various elements to the board while working on Internet Explorer and Edge browsers is as follows

<table>
<thead>
<tr>
<th>Browser</th>
<th>Scenario</th>
<th>Recommended Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Cards</td>
</tr>
<tr>
<td>IE</td>
<td>Without Swimlane</td>
<td>500</td>
</tr>
<tr>
<td>IE</td>
<td>With Swimlane</td>
<td>500</td>
</tr>
<tr>
<td>Edge</td>
<td>Without Swimlane</td>
<td>1000</td>
</tr>
<tr>
<td>Edge</td>
<td>With Swimlane</td>
<td>1000</td>
</tr>
</tbody>
</table>

• Access Visual Task Boards on your mobile device using either a browser or the native mobile app. See supported devices for more information.

**Scripting support**

Visual task boards do not interact with client scripts. Use a UI policy or a data policy instead.

**Task board structure**

Different types of task boards work for different kinds of task management. However, all board types share the same overall structure.

<table>
<thead>
<tr>
<th>Board type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freeform boards</td>
<td>Display all types of task records, including personal tasks. Members of freeform boards can add and remove task cards and lanes.</td>
</tr>
<tr>
<td>Flexible boards</td>
<td>Display tasks that match a filter against a particular table. Members of flexible boards can add task cards. Cards are removed automatically when the tasks no longer match the filter conditions. Members can define custom lanes, similar to a freeform board.</td>
</tr>
<tr>
<td>Guided boards</td>
<td>Similar to flexible boards except that guided board lanes correspond to field values and cannot be edited in most cases.</td>
</tr>
</tbody>
</table>
You can identify the task board type by the icon beside the board name.

- **The freeform board icon:**
  
  ![Freeform Board Icon](image)

- **Flexible board icon:**
  
  ![Flexible Board Icon](image)

- **Guided boards:**
  
  ![Guided Board Icons](image)

Sample Visual Task Board dashboard

All boards have these elements. The color of the left boundary of a card represents the color you choose in the color palette for that board.
### Task board elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick panel</td>
<td>Displays labels and users associated with the board. Board members can use the quick panel to quickly label or assign tasks. Members can also configure what appears in the quick panel.</td>
</tr>
<tr>
<td>Lanes</td>
<td>Organize cards on a board into vertical groups. These groups often represent the status of the task, such as <strong>To Do</strong>, <strong>Doing</strong>, and <strong>Done</strong>. When using a guided board, each lane represents a possible field value. For example, a board on the Incident table can display one lane for each State value such as <strong>New</strong>, <strong>Active</strong>, or <strong>Resolved</strong>. Users can move cards from one lane to another to update the task that card represents.</td>
</tr>
<tr>
<td>Cards</td>
<td>Represent individual tasks that you can assign to users. You can add comments, attachments, and labels to cards. Each card is tied to a task record; updating one immediately updates the other. For freeform boards, each card represents a personal task. For flexible and guided boards, each card represents a record from the list that board was created from. For more information, see Create Flexible and Guided boards topic</td>
</tr>
<tr>
<td>Task board tools</td>
<td>Displays board information, board members, the board activity stream, and board labels.</td>
</tr>
<tr>
<td>Board header</td>
<td>Displays the board name in the title bar. You can rename the board by double-clicking on the board name. Filter the tasks in the board by: • Entering the title or number of the task card • Selecting any one of the options in the Due By drop-down</td>
</tr>
<tr>
<td>Swimlanes</td>
<td>Organize cards on a board into horizontal lanes. These lanes often represent the user assigned to a task. You can add any number of swimlanes to the board, and move cards from one user to another easily.</td>
</tr>
</tbody>
</table>
Sample Visual Task Board elements

Visual Task Board use

Any user can create, view, and edit freeform, flexible, and guided visual task boards, and add users to these boards as members.

You can create a freeform board and add cards from multiple task tables, or create a flexible or guided board from an existing list of records.
Create a freeform board

You can create freeform Visual Task Boards (VTBs) for tracking any kind of task or project.

Role required: none

2. Next to My Task Boards, click New, or if you have never created a task board before click Create New Visual Task Board.
3. From the Create New Board window, click Freeform.
   A new task board opens with the default freeform lanes, To Do, Doing, and Done.
4. Click the board name and enter a new name.

After the board is created, board members can:
- Add and modify lanes
- Create and modify task cards
- Add and remove members
- Configure the look and feel

Create a data driven board

You can create a flexible or guided data driven Visual Task Board (VTB) for any table that extends Task, such as Incident or Change.

Role required: none

2. Next to My Task Boards, click New, or if you have never created a task board before click Create New Visual Task Board.
3. From the Create New Board window, click Data Driven Board.
4. From the Task Table list, select a base table of tasks on which to base your board, for example, an incident table.
5. Optional: From the Lane Field list, select the field you want to use for the lane headers. Create a Flexible board with editable lane headers by selecting None.
   The type of board that is created and the lanes that appear on the board depend on which type of column you select. If you select a reference or choice column, the board is a guided board. Each lane in a guided board represents one possible value for that column and the cards appear in the appropriate lane. For example, if you create a guided task board for incidents using the State column, the board shows one lane for each incident state, such as New or Closed. If you select a column that is not a reference or choice, the board is a flexible board and the board shows the default lanes, To Do, Doing, and Done, with all cards in the To Do lane.
6. Optional: Create a filter to show only the records you want to work with.
   For example, you might filter out incidents that are not assigned to you.
   Any card that no longer fits the parameters of the filter is automatically removed from the task board.
7. Optional: Click the board name and enter a new name.

Nota: For guided boards created from choice fields, such as State, the system creates a lane for each possible choice value. For guided boards created from reference fields, the system creates a lane only for each value in use by a task card. Lanes are added as needed if the reference field values change.

After the board is created, board members can:
• Add and modify lanes
• Create and modify task cards
• Add and remove members
• Configure the look and feel

Delete a task board

You can delete any task board you own.
Role required: none
Deleting a board does not impact the underlying task records. However, you cannot recover a board after you delete it.
2. Under Boards you own, point to a board and click the delete icon (X).
3. In the confirmation dialog, click Delete.

Add or modify task board lanes

Any board member can change the names and add new lanes to accommodate the task workflow you want to track. When you create a freeform or flexible task board, it includes the default lanes To Do, Doing, and Done.
Role required: none
Unlike guided boards, the lanes on a freeform or flexible task board do not match possible field values.

Note: You cannot remove lanes from guided boards.

1. Open a task board.
2. Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create a new lane     | a. Scroll past the last lane and click Add Lane.  
b. Enter a title for the lane, then press the Enter key.  

The Add Lane option is always available for freeform and flexible boards. It is available for guided boards only if the lanes are based on a reference field, such as Assigned to.

| Rearrange lanes       | Click a lane header and drag the lane to the desired drop zone. To cancel the move, press the Escape key while you drag the lane.  
You can also change the lane order from the board configuration menu. |
|-----------------------|-------------|

| Hide a lane           | a. Click the lane menu (団) in a lane header.  
b. Select Hide Lane. You can restore hidden lanes from the board configuration menu. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Delete a lane          | a. Click the lane menu in a lane header.  
b. Select **Delete Lane**.  
c. In the confirmation dialog box, click **Delete**. When you delete a lane on a freeform or flexible board, all the cards in the deleted lane are archived. |

The **Delete Lane** option is always available for freeform and flexible boards. It is available for guided boards only if the lanes are based on a reference field, and only for lanes that contain no cards.

| Exclude Child Table Records | a. Click **Info** icon  
b. Under **Structure** menu, select **Exclude Child Table** |
|----------------------------|---------------------------------------------------------------------------------------------------------------------------------------------|

Records

The Child Table lanes and records are excluded.

**Note:** Values from Child Table Records show up only in case of choice type fields. It is not available for other field types.

**Task cards**

Visual Task Board task cards can represent a personal task or a record on a table.

You can add task cards, edit task card details, add labels to cards, and access the underlying task record the card represents, depending on the board type.
**Note:** Each board can display up to 2,000 cards by default. When the number of tasks exceeds the maximum, a warning appears and the system determines which cards to show by most recent update time. Administrators can configure a different maximum card limit task boards.

### Freeform board tasks

You can add personal task cards directly to lanes on a freeform board. You can also add other kinds of task cards to a freeform board from a list or form.

**Add a personal task to a freeform board**

You can add cards directly to a freeform board lane. These cards are called personal tasks and represent records on the Private Task [vtb_task] table.

**Role required:** none

1. In a lane header, click the lane menu and select **Add Task**. Alternatively, click **Add Task** at the bottom of a lane. A new task card appears in the lane.
2. Enter a short description for the new task card.
3. To save the card, click another area of the board or press **Enter**.

**Add a task to a freeform board from a form**

You can add a task card to a freeform board from any table that extends Task. These cards represent records on whichever table you add them from.

**Role required:** none

You can add cards from multiple task tables, such as Incident or Problem, to the same freeform board.

1. Open a task record, such as an incident.
2. Click the menu icon or right-click the form header to show the form context menu.
3. Select **Add to Visual Task Board**. A pop-up window appears with a list of freeform task boards.

![Choose a Visual Task board](image)

4. Click the name of the board you want to add the card to. A confirmation message appears.

5. To view the board, click the board name in the confirmation message. The task appears in the first lane by default.

**Add a task to a freeform board from a list**

You can add a task card to a freeform board from any table that extends Task. These cards represent records on whichever table you add them from.

Role required: none

You can add cards from multiple task tables, such as Incident or Problem, to the same freeform board.

1. Navigate to a list of task records, such as **Incident > Open**.

2. Perform either of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add one task</strong></td>
<td>Right-click a record and select <strong>Add to Visual Task Board</strong></td>
</tr>
</tbody>
</table>
### Add multiple tasks

Select the check box beside each record you want to add and select **Add to Visual Task Board** from the actions choice list.

A pop-up window appears with a list of freeform task boards.

3. Click the name of the board you want to add the card to.
   - A confirmation message appears.
4. To view the board, click the board name in the confirmation message.
   - The task appears in the first lane by default.

### Data driven board tasks

You can add a task to a flexible or guided task board.

**Add a task to a flexible or guided board**

Cards in a flexible or guided board represent records on whichever table the board is associated with.

**Role required: none**

1. In a lane header, click the lane menu (אים) and select **Add Task**. Alternatively, click **Add Task** at the bottom of a lane.
   - A pop-up window appears with a new record. Fields are populated based on any filter conditions for the board and, for guided boards, the lane you add the card to.
   - Consider the example of a guided board that shows incidents with the **Software** category, with a lane for each assignee. If you add a card to the **ITIL User** lane, the new incident record **Category** and **Assigned to** fields are automatically set to **Software** and **ITIL User**.

2. Complete the form and click **Submit**.
   - A new task card appears in the lane.
Edit Visual Task Board card details

Edit the details of the card by clicking a card on a Visual Task Board. A pop-up window appears with additional details of the card.

Role required: none

You can edit various the card details. Updating these values also updates the underlying task record.
Can't log into SAP from my laptop today

Tried to connect to SAP and all I see is a "Connecting..." message but nothing else happens.

Sample Visual Task Board card
2. Click a card on the board.
   The details for the card appear in a pop-up window.

3. From the card details pop-window, you can:
   • Rename the card by clicking the card title and providing the new name.
   • Modify the short description.
   • Add comments or work notes in the activity stream.
   • Edit the users assigned to tasks.
   • Add a label to the card by clicking one or more of the available labels.
   • Add or edit the **Due Date**. If the completion of a task exceeds the due date, the date appears in red.

   • Add or remove file attachments.
   • Create a checklist.
   • Archive the card (freeform boards only).
   • Move the card to a different board (freeform boards only).

---

**Add an attachment to a task card**

You can add an attachment to a record within a task board.

**Role required:** none

Adding an attachment to a task card also adds the attachment to the underlying task record.
Add attachment

1. Click a card.
2. Click the attachment tab

3. Click **Add Attachment** and select a file to add as an attachment.

**Label a task card**

Labels help categorize tasks and visually distinguish them on the task board.

**Enable** labels for the board.

Role required: none

You can filter the visible tasks to show only those with certain labels. Labels appear on cards as colored dots.

**Task card labels**

You can add one or more labels to a task card.

Do one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add a label to a card from the quick panel</strong></td>
<td>a. Drag a label from the quick panel directly to a task card.</td>
</tr>
<tr>
<td></td>
<td>b. Drop the label in the drop zone.</td>
</tr>
<tr>
<td><strong>Add a label to a card from the card details</strong></td>
<td>a. Open the card details for a task.</td>
</tr>
<tr>
<td></td>
<td>b. Click the details tab (i).</td>
</tr>
<tr>
<td></td>
<td>c. Under <strong>Labels</strong>, select one or more labels. Point to a label to display its name.</td>
</tr>
<tr>
<td></td>
<td>d. Close the card detail pop-up window.</td>
</tr>
</tbody>
</table>

You can use configuration options to **rename or disable** labels or to **hide** labels altogether.
**Assign a task card to a user**

Assignees represent ownership of task cards and the associated records. Each task card can have one primary assignee and multiple additional assignees.

You can filter the visible tasks on a board to show only tasks assigned to a certain user. Assignees appear on cards as avatars.

![Assignees](image)

Task card assignees

When a card changes lanes, all the assignees receive an email notification.

For flexible and guided boards, the primary assignee corresponds to the underlying task's **Assigned to** field. For example, on a board created from the Incident table, if you add Joe Employee as the primary assignee for a card, the associated incident is assigned to Joe. Note that assignment rules on the associated table may restrict who you can make the primary assignee of a card. If you attempt to assign a task card to a user in a way that violates an assignment rule, a notification appears and the assignment does not take place.
Note: Assignees are not automatically granted access to the board. Only members can access the board.

Do one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add an assignee from the quick panel</td>
<td>a. Drag a user’s avatar from the quick panel directly to the task card.</td>
</tr>
<tr>
<td></td>
<td>b. Drop the avatar in the Primary or Additional drop zone.</td>
</tr>
<tr>
<td>Add an assignee from the card details</td>
<td>a. Open the card details for a task.</td>
</tr>
<tr>
<td></td>
<td>b. Click the assignees tab (👥).</td>
</tr>
<tr>
<td></td>
<td>c. Click Add Primary Assignee or Add Additional Assignee. The Add Primary Assignee option is not available if there is already a primary assignee.</td>
</tr>
<tr>
<td></td>
<td>d. Select a user.</td>
</tr>
<tr>
<td></td>
<td>e. Close the card detail pop-up window.</td>
</tr>
</tbody>
</table>

The system sends an email notification to inform the new assignee of the change.

Visual Task Board checklists

Checklists help you track the progress of tasks on your Visual Task Board.

Checklists are available as a tab in the card details.
Sample checklist

You can add, remove, or rearrange checklist items. You can also save a checklist as a template for future use on other cards. Any user can create or edit a checklist. When the compact card view is disabled, the task card displays a progress bar to show how many items are complete.
You can also use checklists with task records in the standard interface. For more information, see #unique_3094.

**Create a checklist for a card**

You can create a unique checklist for each Visual Task Board card or create a task from a checklist item.

Role required: none

1. Open the card details for a task.
2. Click the checklist tab (✓).
3. Click **Add Item**.
4. Enter text for the checklist item.
5. Press the Enter key to add the checklist item.
6. Create as many additional checklist items as desired.
7. To delete a checklist item, click the minus (-) icon.
8. To reorder checklist items, click the drag icon (_drag icon_) and drag a checklist item to a different position in the list.
9. To create a task from a checklist item:
   a) Point to a checklist item and click the create task icon (△).
   b) Select the type of task you want to create.
      An administrator can configure which task types are available.
      The new task record appears in a pop-up window. The short description is automatically populated with the checklist item text.
   c) Fill in the form with additional detail as necessary.
   d) Click Update.

Create checklist template
A template saves time by creating checklist items automatically. You can add, edit, or remove checklist items without impacting the template.

Role required: none
1. Open the card details for a task.
2. Click the checklist tab (✓).
3. Add items to the checklist that you want to save as part of the template.
4. Click the more icon (⋯).
   The more icon does not display unless you have added an item to the checklist, or if you have a pre-existing checklist template.
5. Select Save as Template.
6. In the dialog box, enter a descriptive template name to identify the checklist.
   When a user creates a checklist from a template, all templates are listed in alphabetical order and there is no way to filter which templates appear. To provide a better user experience, consider implementing a naming system for checklist templates. For example, include the name of the table or another identifier to clarify how the checklist should be used.
7. Click Save.

Create a checklist from a checklist template by selecting the template from the more icon.

Delete a checklist from a card
You can remove a checklist from a Visual Task Board card.

Role required: none
1. Open a task card that contains a checklist.
2. Click the checklist tab (✓).
3. Click the more icon (⋯).
4. Select Remove Checklist.
   A confirmation dialog box appears.
5. Click Delete.

Configure which types of tasks can be created from checklist items
A system property controls which types of tasks you can create from a Visual Task Board checklist item.

Role required: admin
You might want to add custom tables or remove tables you do not use.

1. Navigate to `sys_properties.list`.
2. Locate the `glide.ui.create_task_type_option_list` property.
3. Edit the Value to add or remove tables.

You can add any table that extends Task [task]. Use the table name, not the label. For example, you would enter `change_request`, not Change Request. Ensure the tables listed are separated by commas, with no spaces.

The property value populates the task type selection list users choose from when they create a task from a checklist item. Note that users can only see task types for which they have the appropriate access roles.

---

**Archive a card**

Archiving a card is a non-destructive way to remove a card from a freeform board. You can archive cards you are no longer working on to reduce visual clutter.

Role required: none

**Note:** You can only archive cards on a freeform board.

- Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive one card from the lane view</td>
<td>1. Point to a card and click the X icon that appears in the corner.</td>
</tr>
<tr>
<td></td>
<td>2. In the confirmation dialog, click Archive.</td>
</tr>
</tbody>
</table>

| Archive one card from the card details| 1. Click a card and view the Details tab.                                    |
|---------------------------------------| 2. Under Tools, click Archive.                                                |
|                                       | 3. In the confirmation dialog, click Confirm.                                 |
## Archive all the cards in a lane

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Archive all the cards in a lane | 1. In the lane header, click the more options icon ( ).  
2. Select **Archive All Tasks**.  
3. In the confirmation dialog, click **Archive**. |

- To see all archived cards for the current board, from the board navigation panel, open the board information menu ( ) and click **View Archived Tasks**.
- To restore an archived card, point to it and click **Restore**.

## Access a task record from a VTB card

You can open the form view of any task card. Viewing a task record on a form allows you to see all fields for that record, including fields that are not visible in the card details.

Role required: none

Access a task record using one of the following options.

- Access the record from the task card by clicking the record number on the task card.
- Access the record from the card details by doing the following:
  a) Open the card details for a task.
  b) Click the record number in the header.

## Move a card to a different lane

You can move a card from one lane to another.

Role required: none

When you move a card to a different lane on a guided board, the field on which the lanes are based is updated to reflect the new lane value.

1. Open a Visual Task Board.
2. Select a card and drag it to a different lane.
   - To cancel the move, press the Escape key while you drag the card.

**Note:** All mandatory fields on a record must be filled in to move the associated card to a new lane. For example, assume you have a guided board based on the Incident [incident] table, with a lane for each State. The Close code and Close notes fields become mandatory when the State changes to Closed. If you attempt to move an incident card from the New lane to the Closed lane, a pop-up view of the form appears and prompts you to fill in the mandatory fields.

## Move a card to a different board

You can move a card from one freeform board to another.

1. Open the card details.
2. In the details tab ( ), click **Move Card**.
3. In the pop-up window that appears, select the board and lane to move the card to.
The board selection list displays freeform boards only.

**Task board tools**

The task board tools area in a Visual Task Board contains several tabs, each represented by an icon.

Click an icon to open the tab. Click the same icon again to hide the tab. The tabs you see for each conversation depend on the conversation type and other conditions.

**Conversation tool tabs**

<table>
<thead>
<tr>
<th>Tab icon</th>
<th>Tab name</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![info icon](image) | Info | Contains the following information about the task board:  
- Board Name  
- Board type  
- Board Owner  
- Number of members  
- Number of assignees  
- Number of lanes  
- Number of tasks  
- Table name  
- Filter conditions (visible on data driven boards only)  
- Lane field (visible to the board owner, on data driven boards only)  
- Swimlane field - To change Swimlane field for the board  
- Due Date field - To change the Due Date field for the board.  
- URL |
| ![members icon](image) | Members | Lists all members and assignees of the board. You can add or remove board members, promote assignees to be members, and filter the board by member or assignee. |
| ![labels icon](image) | Labels | Use labels to visually distinguish tasks on the task board. Filter board contents by toggling the label. You need to enable labels before being able to use this tab. |
| ![activity icon](image) | Activity | Displays all of the activity for cards on the board. |
### Tab icon | Tab name | Description
--- | --- | ---
 | Configuration | Configure the settings for the task board. This setting is only available for the board owner. For more information, see [Configure a task board](#)  

### View board information

You can display key information about any task board.

Role required: none
Board owner's view of board information

1. Open a task board.
2. Click the board information icon (i).

Add a board as a favorite

Add boards you access frequently to the application navigator using the favorite option.

Role required: none
Adding a board as a favorite is only available in UI16.

1. Navigate to **Self Service > Visual Task Boards.**
2. From the board you want to favorite, select the information icon from the board tools. Then select the star.
3. Remove the board as a favorite by clearing the star icon.

**View a task board in a list**

You can view a task board in the list view using the board information option.

Role required: none

1. Open a task board.
2. From the task board tools, click the board information icon (i).
3. Click **View List** at the bottom of the information panel.
   The cards from the board open in the list view.

**Note:** The freeform board list view only shows cards made by the board and no other tasks that might be added manually.

**Add or remove a task board member**

You can add and remove task board members using the members tab of the activity stream. You can also promote assignees to board members.

Role required: none

Only members of a task board can access the board. Any board member can add or remove other members.

1. On a Visual Task Board, open the task board tools.
2. Click the members tab.
3. Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a member</td>
<td>a. In the <strong>Users</strong> section, click <strong>Add Members</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Enter a user's name or select a user from the drop-down menu.</td>
</tr>
<tr>
<td>Remove a member</td>
<td>a. In the <strong>Members</strong> section, point to a user.</td>
</tr>
<tr>
<td></td>
<td>b. Click the remove icon</td>
</tr>
<tr>
<td>Promote an assignee to</td>
<td>a. In the <strong>Assignees</strong> section, point to a user.</td>
</tr>
<tr>
<td>a member</td>
<td>b. Click the upward arrow icon.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Promote all assignees to members</td>
<td>In the Assignees section, click Promote All.</td>
</tr>
</tbody>
</table>

**Visual Task Board SLA indicators**

SLA (service level agreement) indicators alert board members if any cards on the board have breached SLAs.

When SLA indicators are enabled, a status bar appears on each card that has an associated SLA. If any cards have breached SLAs, an alert appears at the top of the board and a filter option appears in the quick panel. The indicator displays the elapsed percentage of the SLA. If there are multiple SLAs associated with a task card, the indicator displays the status of the SLA with the greatest elapsed percentage.
Alert! One or more tasks on this board require immediate attention.

- SSL certification issue: SLA: 52%
- Trouble getting to Oregon mail server: Unassigned
- Can't access SFA software: Unassigned
- Please remove the latest hotfix from my PC: SLA: 21%
- Phishing scam?
- Unable to get to network file shares
- Network storage unavailable
- JavaScript error on hiring page of corporate website
Any board member can enable SLA indicators from the board configuration menu. The setting applies to the current user only.

**Share a Visual Task Board in a Connect conversation**

You can share a Visual Task Board in a Connect Chat or Connect Support conversation.

Role required: none

1. Navigate to **Self-Service > Visual Task Boards**.
2. Drag a task board to a Connect mini window.
   - A link to the task board appears in the conversation. The task board is also listed in the conversation tools, which are visible in the Connect workspace. Only conversation members who are members of the board can access it. If you share a task board in a record conversation, it appears as a URL in the record activity stream.

**Create a Connect conversation from a Visual Task Board**

Create a Connect Chat conversation from a Visual Task Board to collaborate with board members and keep track of activity as it happens.

Role required: none

When you create a conversation from a task board, all the board members become members of the conversation. The members are synchronized between the task board and the conversation. For example, if you remove a user from the conversation, the system automatically removes the user from the board as well.

1. Navigate to **Self-Service > Visual Task Boards**.
2. Open a task board.
3. In the board header, click the connect with board members icon ( ).
   - The system automatically opens a record conversation for the board. Each board member becomes a member of the conversation.

**Visual Task Board accessibility**

Several accessibility improvements are included in Visual Task Boards.

**Skip links**

Skip links allow you to tab directly to the main content on a page. When accessibility mode is enabled, task boards include a skip link to view tasks as a list. The View tasks as a list skip link switches all the task cards to the table view. For more information on viewing task boards in a list view, see .

**View card details**

With accessibility mode enabled, visual indicators appear on task cards that users can tab to in order to open card details. For more information, see View card details in a task board.

**View card details in a task board**

With accessibility mode enabled, tab through cards in a task board. Use the card details button to view task card details.
Enable accessibility from the General tab of the system settings menu.
Role required: none

1. Navigate to **Self-Service > Visual Task Boards**.
2. Open an existing task board.
3. Press the Tab key to navigate through the board to get to a task card.
4. Press the Tab key to navigate through the card until the Open Card Details button appears.

5. Press **Enter** to open the card.
6. To exit the card, press **Escape**.

**Configure a task board**

You can configure several options in the Visual Task Boards to customize the look and feel of the board.
Role required: none

1. From the task board tools, click the menu icon ( ).
2. Click **Advanced Settings**.
3. In the **Theme** section, select a color from the palette. The selected theme is applied to the background of the board, lane header, add card button, quick filter, tab header, quick panel, and board header. It also appears as the color for the board on the My Task Boards page. This setting applies only to the boards of the user.
4. In the Quick Panel section, toggle the options to customize the quick panel.

**Note:** Unless otherwise noted, these settings apply to the current user only.

### Quick panel options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Panel</td>
<td>Option for making visible on the board.</td>
</tr>
<tr>
<td>User Names</td>
<td>User names that appear next to user avatars in the quick panel.</td>
</tr>
<tr>
<td>Show Labels</td>
<td>Labels that appear on cards and in the quick panel.</td>
</tr>
</tbody>
</table>

**Note:** The setting applies to all users.

| Label Names  | Label name that appears beside the colored icon for that label in the quick panel. |

**Note:** This setting is available only when you enable **Show Labels**.

When all the options are enabled, a quick panel looks like the following illustration.

5. In the Configure Cards section, toggle the options to customize the appearance and information of cards.

Changes to the cards apply to the current user only.

### View options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compact Cards</td>
<td>Decreases the lane width and card information. Thumbnail images do not appear on the card.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Card Info</td>
<td>Displays card information on each card. Card information typically includes details like the task state, date opened, and last user to update it. This setting is available only when Compact Cards is disabled.</td>
</tr>
<tr>
<td>Show Card Attachment</td>
<td>Cards display the first image attached to that card as a thumbnail. This setting is available only when Compact Cards is disabled.</td>
</tr>
<tr>
<td>Show SLAs</td>
<td>SLA status indicators appear on cards and alerts appear when one or more card has a breached SLA. SLA status indicators are hidden when Compact Cards is enabled. This setting is available only when SLAs are associated with the tasks on the board.</td>
</tr>
</tbody>
</table>

6. Under Advanced Settings, in the Lane Configuration section, show or hide lanes by selecting or clearing the check box for each lane. This setting is a user preference.

**Configure Visual Task Boards labels**

Labels help categorize tasks and visually distinguish them on the task board. You can disable or rename labels using the labels tab of the activity stream.

Role required: global_tags_creator, if you want to add or rename labels.

Every board has seven labels by default.
Any board member can edit the labels on a board. All the labels are visible on the **Quick Panel** under **Labels**

1. From the task board tools, click the **Labels** tab.

2. Turn on the **Show Labels** button if it is turned off. You can see seven default labels.
   - Users with global_tags_creator role can add labels to the board and rename the label
   - To add labels, click **Add**
Newly added label remains in off state by default. You can assign any color or no color to the label. To rename the label, click the label text and enter new value.

- To change the color of the label, click the **Select color** icon beside the label. Select the color of your choice from the color picker and click **Save**.

- To disable or enable a specific label, toggle the button next to the label. To turn on or turn off a specific label, toggle the button next to the label. Only turned on labels show up in the quick filter and can be applied to a card.

- Board owner can delete the label by clicking **Delete Label** icon.

- To filter the cards by labels, type the Label name in the Search bar or click **Add to Filter**.
Labels on Card Details Page

When user clicks the card, the card opens with the details of the card. It contains all the applied labels under Details tab.

Under the Labels tab, the toggle button for applied labels is On and Off for the labels that are not applied.
Configure Visual Task Boards with swimlanes

Swimlanes enable you to create an environment with horizontal lanes in addition to vertical lanes. Swimlanes use only compact cards in the task board.

Role required: none

You can add swimlanes in the following types of the visual task board.

- Freeform Board
- Flexible Board
- Guided Board

You can perform following activities when you choose swimlanes in Visual Task Boards.

- Name and rename the swimlanes as per your choice.
- Move the tasks horizontally and vertically as needed from one user to another.
- Drag the cards across swimlanes.
• Reorder swimlanes as per choice by dragging them or from **Lane Configuration**.

![Lane Configuration](image)

• Collapse and expand swimlanes as per your choice.

1. Navigate to **System Definition > Self-service > Visual Task Boards**.
2. Click **New** and select the board type.
   • Freeform Board
   • Data Driven Board
3. Configure swimlanes in the boards as follows:
   a) In a freeform board, activate the swimlanes by sliding the swimlanes toggle in the **Info** tab to the right.

The following figure shows a sample freeform board created with swimlanes.
b) To enable swimlanes in a Data Driven Flexible board, select **None** in **Vertical Lane Field** from the drop-down.

c) Click **Next** and slide the toggle under the **Info** tab to the right.

The following figure shows a data driven flexible board created with swimlanes.
d) To enable swimlanes in a data driven guided board, select **Vertical Lane Field** and **Swimlane Field** while creating the board. You can also add swimlanes to the existing guided board by selecting **Swimlane Field** under **Info** tab in the board.
The following figure shows a data driven guided board with swimlanes.
<table>
<thead>
<tr>
<th>Status</th>
<th>In Progress</th>
<th>On Hold</th>
<th>Resolved</th>
<th>Closed</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>33</td>
<td>11</td>
<td>0</td>
<td>23</td>
</tr>
</tbody>
</table>

Unable to edit Sales forecast ...

- Created by: Beth Anglin 12/31/21 12:01 PM
- Assigned to: Bow Ruggerli
- Status: In Progress

The USB port on my PC is not ...

- Created by: ITIL User 12/31/21 12:01 PM
- Assigned to: Beth Anglin
- Status: In Progress

Can't launch 64-bit Windows ...

- Created by: ITIL User 12/31/21 12:01 PM
- Assigned to: Bud Richman
- Status: In Progress

CPU load high for over 10 min...

- Created by: ITIL User 12/31/21 12:01 PM
- Assigned to: ITIL User
- Status: In Progress
Modify the query or lane field for an existing board

For flexible and guided boards, you can edit the board query or lane field. This ability enables you to change the board contents while preserving the member list, board configuration settings, and, if applicable, Connect Chat conversation history.

Inform the board members that you plan to change the board query or lane field. If you or any members have manually sorted cards within a lane, the order may be reset.

Role required: none but you must be the board owner

The board query consists of filter conditions that determine which tasks the board tracks. For example, you might edit the query so the board shows only active incidents, rather than all incidents.

The lane field is the field on the underlying table that defines the lanes. For example, you might change the lane field so the lanes represent incident states, rather than assignees. This change is called a lane field pivot. Lane field pivots also make it possible to convert a flexible board to a guided board or vice versa.

1. Open a task board.
2. Click the board information icon (i) by the board name.
3. Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the board query</td>
<td>a. Under Board Filter, click Edit Filter to open the condition builder.</td>
</tr>
<tr>
<td></td>
<td>b. Add and remove conditions as needed to edit the query.</td>
</tr>
<tr>
<td></td>
<td>c. Click Save.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the lane field</td>
<td>a. Click the Lane Field picker and select a field or the None option.</td>
</tr>
<tr>
<td></td>
<td>Guided boards have the Lane Field set to a field, such as State. Flexible boards have the Lane Field set to None. You can change the Lane Field value accordingly to change the board type.</td>
</tr>
<tr>
<td></td>
<td>b. In the confirmation dialog, click OK.</td>
</tr>
</tbody>
</table>

The board reloads to reflect the changes.

Configure WIP Lane Limit

You can set a limit to the number of cards added to a lane. If the limit is not set, any number of cards can be added to a lane by default.

Role required: admin

1. Open the Visual Task Board.
2. Click on the lane header.
3. Select Set Lane Limit. Set Lane Limit for <name of the lane> window appears.
4. Enter the number you want to set for the specific lane. Leave blank, if you want set no limit to the lane.
5. Click **Save**.

The number appears on the lane header.

If the number of cards exceeds the set limit, the Red symbol appears on the lane header for all the board members.

If a card is moved to a lane with exceeded WIP lane limit, the error message appears on the top of the page. The member who moves a card to the lane with exceeded limit can view the error message.

**Configure the card limit for Visual Task boards**

Freeform and Data Driven boards can display up to 1,000 cards by default. You can change the default card limit by adding a property.

Role required: admin

You can set card limit for both Freeform board and Flexible and Guided board in Data Driven board.

1. Add a new system property with the following field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.vtb.board_max</td>
</tr>
<tr>
<td>Type</td>
<td>integer</td>
</tr>
</tbody>
</table>

2. Set the **Value** to the maximum number of cards allowed for each board.

**Note:** Performance degradation may occur if you set the **Value** to a number greater than 1,000, especially on tablet devices.

**Configure the task board card view**

Configure the fields that appear in a card on a task board.

Role required: admin

1. Navigate to the form you want to configure fields for.
2. Right-click the header and select **Configure > Form Layout**.
3. Under the Form View section, select the VTB view.

You may need to create a VTB view for the form. For more information, see Create and delete views.
4. Select the fields to appear on the card by adding or removing the fields from the **Selected** column. You can also adjust the order they appear on the form by moving the fields up or down.

### Workflow

Workflow provides a drag-and-drop interface for automating multi-step processes across the platform. Each workflow consists of a sequence of *activities*, such as generating records, notifying users of pending approvals, or running scripts. The graphical Workflow Editor represents workflows visually as a type of flowchart. It shows activities as boxes labeled with information about that activity and transitions from one activity to the next as lines connecting the boxes.

**Note:** As of the New York release, Workflow is a legacy product. Use Flow Designer for any new process automation. As many organizations have workflows in production, use this Workflow documentation to learn how to work with existing workflows.

---

**Explore**
- Upgrade to New York
- Workflow movement with update sets
- Workflow activity pinning
- Domain separation and Workflow
- Workflow training on the ServiceNow® Developer Site

**Set up**
- Getting started with workflows

**Administer**
- Workflow roles
- Administering workflow contexts

**Use**
- Workflow editor
- Create a workflow
- Workflow activities

**Develop**
- Developer training
- Developer documentation
- Workflow API reference
- Using variables in a workflow

**Troubleshoot and get help**
- Ask or answer questions in the Developer Community
- Troubleshoot workflows
- Search the HI knowledge base for known error articles
- Contact ServiceNow Technical Support

---

**Getting started with workflows**

The graphical Workflow Editor provides a drag-and-drop interface for automating multi-step processes across the platform.

**Parts of a workflow**

Workflows consist of these parts.

**Properties**

Specify configuration settings such as the workflow name, the table whose records the workflow acts on, and the conditions under which to run it.

**Activities**

Specify the sequence of operations the workflow performs such as generating records, notifying users of pending approvals, or running scripts.
Transitions
 Specify the conditions under which to run an activity.

Exit conditions
 Specify the conditions under which to run a transition.

Contexts
 Store historical runtime information about a specific workflow run in a Workflow Context record.

Versions
 Store historical design information about a specific workflow in a Workflow version record.

Workflow life cycle
 A workflow starts when a triggering event occurs. Common triggers include a record being inserted into a
 specific table, or a particular field in a table being set to a specified value. For example, you might create a
 workflow that runs whenever a user requests approval for an item they want to order from the catalog. You
 can also schedule workflows to run periodically or call them from scripts such as business rules.

When an activity completes, the workflow transitions to the next activity. An activity might have several
different possible transitions to various activities, depending on the outcome of the activity. Continuing the
example above, if the user's request is approved, the activity might transition to an activity that notifies
someone to order the item. If the user's request is denied, the activity might transition to notifying the user
that their request has been denied.

The graphical Workflow Editor represents workflows visually as a type of flowchart. It shows activities as
boxes labelled with information about that activity and transitions from one activity to the next as lines
connecting the boxes.

At each step in a workflow:

1. An activity is processed and an action defined by that activity occurs.
2. At the completion of an action by an activity, the workflow checks the activity's conditions.
3. For each matching condition, the workflow follows the transition to the next activity.

When the workflow runs out of activities, the workflow is complete. The Workflow Context stores the
execution history of the activities and transitions run. The Workflow Version stores the design history of the
activities, transitions, and exit conditions available to run.

Workflow properties
 The workflow properties specify when to run a workflow and what records it acts on. For more information
about workflow properties, see Workflow properties.

Workflow activities
 A workflow activity contains instructions that are processed by the workflow.

Activities can include running scripts, manipulating records, waiting for a set period of time, or logging an
event. Workflow conditions determine whether or not the activity is performed. Activities can be added,
removed, or rearranged. Transitions can be drawn between activities.

This is an activity that triggers a notification:
Workflow runs activities as the user session that starts them. Workflows started from record operations will run activities as the user session that performed the record operation. Workflows started from schedules or restarted from timers run activities as the System user. Workflows started from script calls run activities as the user session that started the script.

For more information on available activities and their behaviors, see Workflow activities.

Transitions

After the workflow condition is evaluated, the workflow transition determines which activity is performed when the workflow condition is met.

This is a transition that always leads from the Change Approved script to the Change Task activity:

Exit conditions

After a workflow activity is performed, the workflow condition is evaluated to determine which transition is activated.

The condition determines behavior based on a change being approved or rejected:
Sample exit conditions

Workflow example

During workflow editing or while an unpublished workflow is running, only the person who checked out the workflow can view the changes.

After a workflow is published, it is available to other users. The workflow moves through the process as defined in the Workflow Editor. The entire workflow is represented in one screen. For example, this is the Standard Change workflow:
Sample change workflow

Workflow editor

The Workflow Editor is an interface for creating and modifying workflows by arranging and connecting activities to drive processes.

You can manage multiple workflows in the same screen, create custom workflow activities, and use existing activities as data sources. Users with the workflow_creator role can create workflows. Users with the workflow_admin role can create, modify, delete, and publish workflows.

To open the Workflow Editor, navigate to Workflow > Workflow Editor. For information about using the editor, see Create a workflow.

Welcome screen

The editor opens with the Welcome page, which displays a list of active, published workflows. From this tab, you can open existing workflows, create new workflows, and open help resources related to workflow.
Published: Click to view list of published workflows
Checked Out: Click to view list of workflows checked out to current user
Help: Click to view links to help resources for workflow

Workflow button
Click to create a new workflow

tabs
Workflows: Workflow activities and workflows you can use as subflows.
Core: Available workflow activities appropriate for the selected workflow. Contents can include activities provided by the base system and those purchased with orchestration.
Packs: Orchestration activity packs downloaded from the ServiceNow® App Store, organized by vendor and scope. Custom activities and workflows that you scope also appear as packs. Only visible if the orchestration plugin is installed.
Custom: Orchestration custom activities available. Only visible if the orchestration plugin is installed.
Data: Activities in the current workflow that output data. You can use these activities as data sources for other activities. Only visible if the orchestration plugin is installed.

Note: If your workflow welcome page does not look like this example, you may have customized the workflow welcome page before upgrading to New York. You can update the workflow welcome page to the latest version by editing the UI pages.

Navigate to System UI > UI Pages > Workflow Editor welcome. In the UI page record for workflow_editor_welcome, scroll to the Versions related list. Select the row for the version corresponding to the upgrade to New York, right-click and select Revert to this version.

Workflow canvas
After you open or create a new workflow, the system displays the workflow canvas. On the canvas you interact with the Workflow Editor through several different elements: the canvas itself, the canvas tabs, the title bar, the palette, and the palette tabs.

The drawing canvas is where you add activities and configure transitions for checked out workflows. Add an activity by dragging it from the palette to the workflow in the canvas. For more information, see Create a workflow.

- Canvas tabs: Contains tabs for accessing workflows being edited or created.
- Title bar: Displays the workflow name and status. Provides a menu and controls for configuring, testing, and validating workflows.
• **Canvas**: Provides the working surface for creating new workflows or editing existing ones.

• **Palette tabs**: Contains tabs for accessing activities being edited or created.

• **Palette**: Contains all available workflow activities and existing workflows you can use as subflows. Drag activities and subflows to the canvas to create new workflows or edit existing ones.

**Workflow user interface**

**Workflow palette**

The default workflow palette contains workflow activities and existing workflows you can use as subflows. The basic workflow palette contains these tabs:

• **Workflows**: Displays existing workflows and provides controls for creating new ones.
• **Core**: Displays baseline workflow activities available to all systems and Orchestration activities (when Orchestration is activated).

**Workflows tab**

The **Workflows** tab lists existing workflows that you can edit or use as subflows in other workflows. Double-click a workflow to open it in the canvas. To add a workflow as a subflow, drag it to another workflow in the canvas. Click the + icon to create a new workflow.

**Core tab**

The **Core** tab contains the standard activities available by default to all workflows and any activities purchased with Orchestration, organized by category. Click the arrow icons to expand or collapse the activity lists under each category. To add an activity to a workflow, drag it to the canvas. For more information, see *Add an activity to a workflow*.
Workflow editor title bar

When a workflow is opened in the canvas, the title bar displays the workflow title and the workflow status in italics. Possible states are Checked out by <name> and Published.
Workflow editor title bar

Controls on the right side of the title bar manage the workflow.

- **Workflow Properties**: Opens the current workflow's properties form.
- **Start**: Runs the workflow. This control is only available for workflows running on the Global table that are accessible from all application scopes. To test workflows that are on other tables, insert a record into that table that meets the condition of the workflow.
- **Validate**: Tests the workflow prior to publication. Validation detects potential problems that can prevent the workflow from publishing or cause the workflow to fail. For more information, see Workflow Validation.
- **Help**: Opens documentation to help you create the workflow.

Workflow menu

Click the menu icon in the title bar for additional options to configure the workflow.
Accessing the workflow menu

These menu options are available:

### Workflow menu options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Workflow</td>
<td>Creates a new workflow.</td>
</tr>
<tr>
<td>Open Existing</td>
<td>Opens another existing workflow.</td>
</tr>
<tr>
<td>Copy</td>
<td>Creates a duplicate of the workflow. Give the copy a different name.</td>
</tr>
<tr>
<td>Publish</td>
<td>Makes the personal workflow version public, overwriting the current published workflow version. This option is only available for checked out workflows.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Checkout</td>
<td>Creates a personal version of the workflow for you, which you can edit. This option is only available for published workflows.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the workflow. You cannot delete workflows that have contexts associated with them.</td>
</tr>
<tr>
<td>Set Inactive</td>
<td>Inactivates the workflow so that it cannot be used.</td>
</tr>
<tr>
<td>Expand Transitions</td>
<td>Redraws the transitions so that they do not overlap when they leave the activity condition.</td>
</tr>
<tr>
<td>Start Workflow</td>
<td>Starts a test run of the current workflow.</td>
</tr>
<tr>
<td>Validate Workflow</td>
<td>Runs validation tests on your workflow prior to publication. Use this validation to detect potential problems that can prevent the workflow from publishing or cause the workflow to fail. For more information, see Work on workflows.</td>
</tr>
<tr>
<td>Collapse Transitions</td>
<td>Redraws the transitions so they overlap when they leave the activity condition.</td>
</tr>
<tr>
<td>Show Contexts</td>
<td>Displays all the contexts for the current workflow. You can use this option to troubleshoot a workflow.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the Workflow Properties form, which defines the workflow's attributes.</td>
</tr>
<tr>
<td>Edit Inputs</td>
<td>Opens the Workflow Inputs list of variables that the workflow can accept when used as a subflow. For more information, see Pass a variable from a workflow to a subflow.</td>
</tr>
<tr>
<td>Edit Stages</td>
<td>Opens the Workflow Stages list. For more information, see Workflow stages. For tables with a column of Type = Workflow.</td>
</tr>
</tbody>
</table>

**Workflow editor keyboard navigation**

The platform includes accessibility features that support Web Content Accessibility Guidelines (WCAG) 2.0 level A and make the interface accessible to users with disabilities.

These features improve the user experience when accessing platform functions with screen readers and keyboard navigation. In general, you use the following set of standard keyboard navigation functions:

- Press **Tab** to navigate major groupings in a pre-defined sequence. This usually includes moving between standard interface controls (fields and lists) in a module, or between records within a tab.

  Press **Shift Tab** to move backwards in a pre-defined sequence.

- Use arrow keys (left, right, up, down) to navigate between individual elements within a group. This usually includes moving between tabs, or between available selections within a specific control (for example, within a list).

- Press **Enter** to select a control or tab, or enter text within a control.

The Workflow Editor is constructed in a unique manner. It includes a series of main (left) panel tabs, a series of side (right) panel tabs, and a drawing canvas for workflow creation or editing. As such, it has its own unique set of keyboard accessibility functions and commands.
Welcome page keyboard commands

Use keyboard commands to navigate and operate the Workflow Editor Welcome page.
<table>
<thead>
<tr>
<th>Task or Action</th>
<th>Keyboard Commands</th>
</tr>
</thead>
</table>
| Navigate to main content (left) panel, and select a workflow | 1. After accessing the Workflow Editor from a menu, press **Tab**.  
  A **Skip to Main Content** button appears in the upper left corner.  
  2. Press **Enter** to position the cursor in the first record displayed in the **Published** tab.  
  3. Press **Tab** to navigate down the listing of workflow records.  
  Press **Enter** to select and open a workflow record in the Workflow drawing canvas. |
| Select a checked out workflow or a help function in main content panel | 1. After accessing the Workflow Editor from a menu, press **Tab** until the **Published** tab is highlighted.  
  2. Press the right or left arrow keys to navigate between the **Published**, **Checked Out**, or **Help** tabs.  
  3. Press **Tab** to navigate across the columns and down the listing of checked out workflow records or help selections.  
  Press **Enter** to select and open a checked out workflow record in the Workflow drawing canvas, or open a help selection (work or orchestration videos, documentation, community discussions, knowledge base, or live feed). |
| Create a workflow                                  | 1. After accessing the Workflow Editor from a menu, press **Tab** until **New Workflow** is highlighted.  
  2. Press **Enter** to open **New Workflow**                                                                                                                 |
<table>
<thead>
<tr>
<th>Task or Action</th>
<th>Keyboard Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Jump to Top</strong></td>
<td>After tabbing through the displayed records in a tab in the main panel (for example, within the <strong>Published</strong> tab), &lt;br&gt; &lt;br&gt;<strong>Jump to top</strong>&lt;br&gt; appears at the bottom of the listing. Press <strong>Enter</strong> to return to the Welcome tab at the top of the Workflow Editor.</td>
</tr>
<tr>
<td><strong>Navigate to page selection controls</strong></td>
<td>1. After tabbing through the displayed records in a tab in the main panel (for example, within the <strong>Published</strong> tab), including press <strong>Tab</strong> to access the page selection controls. Continue to press <strong>Tab</strong> until you access the desired one. &lt;br&gt; 2. Press <strong>Enter</strong> to operate the selected page control.</td>
</tr>
<tr>
<td><strong>Navigate directly to side (right) panel to open help, create a new workflow, or open an existing one</strong></td>
<td>1. After accessing the Workflow Editor from a menu, press <strong>Tab</strong> two times. Do not select <strong>Skip to Main Content</strong> appears in the upper left corner. &lt;br&gt; 2. Press <strong>Enter</strong> to position the cursor in the <strong>Workflows</strong> tab in the side panel. &lt;br&gt; 3. To open help, press <strong>Tab</strong> to navigate to <strong>Skip to Workflow Side Panel</strong> Press <strong>Enter</strong> to open help, or press <strong>Tab</strong> to skip. &lt;br&gt; 4. To create a new workflow, press <strong>Tab</strong> to navigate to <strong>+</strong> Press <strong>Enter</strong> to open New Workflow, or press <strong>Tab</strong> to skip. &lt;br&gt; 5. To open an existing workflow: &lt;br&gt; • As needed, stop at the filter field to filter workflows. &lt;br&gt; • Press <strong>Tab</strong> to navigate down the workflow list. &lt;br&gt; • Press <strong>Enter</strong> to select and open a workflow record in the Workflow drawing canvas,</td>
</tr>
<tr>
<td>Task or Action</td>
<td>Keyboard Commands</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add a core activity to a checked out workflow in the Workflow drawing canvas</td>
<td>If a checked out workflow is open in the Workflow drawing canvas, core activity records display in the Core tab. To select a core activity and place it in the checked out workflow:</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Core activity records only display when a checked out workflow is open in the Workflow drawing canvas. Other tabs display in the side panel only if Orchestration functions are enabled.</td>
</tr>
<tr>
<td></td>
<td>1. In the Workflow drawing canvas, press <strong>Shift Tab</strong> until <strong>Skip to Workflow Side Panel</strong> appears in the upper left corner.</td>
</tr>
<tr>
<td></td>
<td>2. Press <strong>Enter</strong> to position the cursor in the <strong>Workflows</strong> tab in the side panel.</td>
</tr>
<tr>
<td></td>
<td>3. Press the right arrow key to navigate to the <strong>Core</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>4. Press <strong>Tab</strong> or the down arrow key to navigate down the listing of core activities.</td>
</tr>
<tr>
<td></td>
<td>• To open a core activities folder (for example, Approvals), press the right arrow key.</td>
</tr>
<tr>
<td></td>
<td>• To navigate up the list, press the left or up arrow keys.</td>
</tr>
<tr>
<td></td>
<td>5. Press <strong>Tab</strong> to select a core activity and open the New Activity dialog to specify properties for it.</td>
</tr>
<tr>
<td></td>
<td>6. After creating the activity, remember to link it to another activity in the workflow. See Create a connection from a condition on one activity to the next activity that follows in Workflow drawing canvas keyboard commands.</td>
</tr>
</tbody>
</table>

**Workflow drawing canvas keyboard commands**

Use keyboard commands to navigate and operate the Workflow Editor canvas.
<table>
<thead>
<tr>
<th>Task or Action</th>
<th>Keyboard Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Workflow Actions menu command (for example, <strong>Validate Workflow</strong> or <strong>Publish Workflow</strong>)</td>
<td>1. Press <strong>Tab</strong> until the context menu is highlighted.</td>
</tr>
<tr>
<td></td>
<td>2. Press <strong>Enter</strong> to open the context menu.</td>
</tr>
<tr>
<td></td>
<td>3. Use the down arrow key to move to the command, then press <strong>Enter</strong> to select it.</td>
</tr>
<tr>
<td>Task or Action</td>
<td>Keyboard Commands</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------------------------------------------------</td>
</tr>
<tr>
<td>Set general workflow properties</td>
<td>1. Press Tab until is highlighted.</td>
</tr>
<tr>
<td></td>
<td>2. Press Enter to open Workflow Properties.</td>
</tr>
<tr>
<td>Navigate from activity box to activity box</td>
<td>Simply press Tab or use the arrow keys (right, left, up and down) to navigate from activity to activity within the workflow.</td>
</tr>
</tbody>
</table>

**Note:** Depending on the complexity and number of activity boxes in the workflow, the sequence of navigation is not always predictable. Depending on how you are navigating within the workflow, the navigation sequence is generally (but not always) row-by-row, and focus is usually placed on the nearest activity box.
<table>
<thead>
<tr>
<th>Task or Action</th>
<th>Keyboard Commands</th>
</tr>
</thead>
</table>
| Modify a selected activity. | 1. Navigate to the activity box, then press **Enter** to select it and place it in Edit mode. When you select an activity box, it appears as highlighted.  
2. Once in Edit mode, use **Tab** to move around within the activity box to change or access elements such as:  
   - Activity Properties  
      - **Always**  
      - Title  
      - Node context menu  
      - Delete Node  
   - Condition Properties  
      - Node conditional context menu  
      - Node conditional port options  
   - Note: All elements in a selected activity are only accessible when working with a checked out workflow. When working with a published workflow, you can only access its activity properties and title,  
3. Press **Enter** to select an element, or press **Esc** to escape an element without making changes. |
| Add a condition to an activity. | 1. Within an activity box, select **Always** to access **Condition Properties**.  
2. In **Condition Properties**, specify the conditions for the activity. |
| Create a connection from a condition on one activity to the next activity that follows | 1. Within an activity box, select **Node conditional context menu**.  
2. Select **Link to...** to create a connection to the next activity box that follows, or select **Delete** to delete an existing connection. |
<table>
<thead>
<tr>
<th>Task or Action</th>
<th>Keyboard Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a core or custom activity</td>
<td>1. Within an activity box, select <strong>Node conditional port options</strong> ( ).</td>
</tr>
<tr>
<td></td>
<td>2. Select <strong>Add Core Activity</strong> to access Workflow Activity Definitions to add a</td>
</tr>
<tr>
<td></td>
<td>new core activity, or select <strong>Add Custom Activity</strong> to add a custom activity to</td>
</tr>
<tr>
<td></td>
<td>the workflow.</td>
</tr>
<tr>
<td>Move an activity box</td>
<td>1. Press <strong>Tab</strong> to navigate to the activity box, enter press <strong>Enter</strong> to select</td>
</tr>
<tr>
<td></td>
<td>it.</td>
</tr>
<tr>
<td></td>
<td>2. Use the arrow keys to move the activity box. To move the activity box one pixel</td>
</tr>
<tr>
<td></td>
<td>at a time, press <strong>Shift</strong> while using the arrow keys.</td>
</tr>
<tr>
<td>Validate a workflow</td>
<td>1. Press <strong>Tab</strong> until **** is highlighted.</td>
</tr>
<tr>
<td></td>
<td>2. Press <strong>Enter</strong> to validate the workflow.</td>
</tr>
<tr>
<td></td>
<td>You can also select <strong>Validate</strong> from the Workflow Actions menu.</td>
</tr>
<tr>
<td>Run a workflow</td>
<td>1. Press <strong>Tab</strong> until **** is highlighted.</td>
</tr>
<tr>
<td></td>
<td>2. Press <strong>Enter</strong> to run the workflow.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the workflow is tied to a database table, this function is disabled.</td>
</tr>
<tr>
<td></td>
<td>The workflow runs when the proper table conditions are activated (for example,</td>
</tr>
<tr>
<td></td>
<td>insertion of a new record into the table).</td>
</tr>
<tr>
<td>Close workflow drawing canvas</td>
<td>1. Press <strong>Tab</strong> until **(on the right side of the tab that contains the name of</td>
</tr>
<tr>
<td></td>
<td>the workflow) appears.</td>
</tr>
<tr>
<td></td>
<td>2. Press <strong>Enter</strong> to close the canvas.</td>
</tr>
<tr>
<td>Task or Action</td>
<td>Keyboard Commands</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Publish a workflow</td>
<td>1. Press Tab until the context menu is highlighted.</td>
</tr>
<tr>
<td></td>
<td>2. Press Enter to open the context menu.</td>
</tr>
<tr>
<td></td>
<td>3. Use the down arrow key to move to the Publish command, then press Enter to select it.</td>
</tr>
<tr>
<td>Jump to Top</td>
<td>After tabbing through the entire workflow, appears at the bottom of the listing. Press Enter to jump to the top of the Workflow drawing canvas.</td>
</tr>
</tbody>
</table>

**Workflow management**

Create, edit, validate, and publish workflows to automate multi-step processes across the platform. Understand workflow activities and variables and how to use them effectively. Take a deeper look at how workflows are constructed, validated, and used.

**Create a workflow**

Automate a multi-step process by creating a workflow with the Workflow Editor.

- You must have the workflow_admin or workflow_creator role to use the Workflow Editor.
- If you are designing the workflow as part of an update set process, see Workflow movement with update sets before creating the workflow.

1. Navigate to **Workflow > Workflow Editor**.  
The Welcome tab of the Workflow Editor opens.
2. On the **Workflows** tab in the palette, click **New Workflow**.
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Updated by</th>
<th>Updated At</th>
<th>Published</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog Item</td>
<td>Requested Item</td>
<td>jackson.maint</td>
<td>2009-01-14 08:46:32</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Knowlege - Instant</td>
<td>Knowledge</td>
<td>admin</td>
<td>2019-11-05 06:02:29</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Grant role_dilegator</td>
<td>Change Request</td>
<td>admin</td>
<td>2010-02-25 13:32:49</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Item Designer -</td>
<td>Requested Item</td>
<td>logan.bed</td>
<td>2014-02-24 16:03:23</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Change Request -</td>
<td>Change Request</td>
<td>admin</td>
<td>2019-08-21 07:37:44</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Default SLA workflow</td>
<td>Task SLA</td>
<td>admin</td>
<td>2016-03-07 03:09:31</td>
<td>true</td>
<td>Global</td>
</tr>
<tr>
<td>Change Request -</td>
<td>Change Request</td>
<td>admin</td>
<td>2016-09-21 07:37:38</td>
<td>true</td>
<td>Global</td>
</tr>
</tbody>
</table>

Create a new workflow

Workflow: Core

- Change Request - Emergency
- Change Request - Emergency/change tasks
- Change Request - Normal
- Change Request - Normal/change tasks
- Change Request - Standard
- Change Request - Standard/change tasks
- Comprehensive Change
- Contract Approval
- Default SLA/Repair workflow
- Default SLA workflow
- Delegate roles to a group member
- Emergency Change
- Grant role_dilegator role to user in group
- Item Designer - Approvals
- Item Designer - Fulfillment
- Item Designer - generate approvals for current sequence
- Item Designer Workflow
- Knowledge - Approval Publish
- Knowledge - Approval Retire
A simplified version of the New Workflow form opens.

3. Fill in the **Name** and **Table** fields

4. [Optional] Add a **Description**.

5. [Optional] Do one of the following:
   a) If the **Conditions** UI section is displayed, specify a **Condition** if needed and edit the fields.
      (The **Conditions** UI section shows only if the selected table supports conditions for launching workflows. For example, if you select the sc_req_item table, conditions are not applicable and the **Conditions** UI section is not displayed.)
   b) If the **Stages** UI section is displayed, check that the **State rendering** and **Stage order** fields contain the correct information. (The **Stages** UI section shows only if the selected table supports stages. For example, if you select the sc_req_item table, the **Stages** UI section is displayed.)

6. Click **Submit**.

   The new workflow is created with the **Begin** and **End** activities connected by a single transition.

7. Finish creating the workflow by adding activities, validating, and publishing so the workflow is available to other users.
   
   For more information, see [Work on workflows](#).

8. To change advanced settings for the workflow, click the **Properties** icon  
   ![Properties icon]
   If you make changes, click **Update**.

**Workflow properties**

In the properties of a workflow, you can configure settings such as its application scope, start conditions, schedule, inputs, stages, and run time metrics. You can also view information such as the workflow author, version, and history.

When you create a new workflow, the following fields are available in the dialog box:

- **Name**
- **Table**
- **Description**
- **If condition matches**
- **Condition**

If you click **Diagrammer view**, in **Related Lists**, the following UI sections are available in the dialog box:

- **General**
• Conditions
• Inputs
• Activities
• Application
• Schedule
• Stages
• Estimated Runtime

General

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name to identify the workflow.</td>
</tr>
<tr>
<td>Table</td>
<td>The table for the workflow to run on. Workflows that run on specific tables can still interact with other tables. Select <strong>Global [global]</strong> to run the workflow on all tables.</td>
</tr>
<tr>
<td>Checked out</td>
<td>[Read-only] When the workflow was checked out. Automatically set by the <strong>Checkout</strong> action in the workflow menu.</td>
</tr>
<tr>
<td>Checked out by</td>
<td>[Read-only] The user who has this workflow checked out. This value is automatically set by the <strong>Checkout</strong> action in the workflow menu.</td>
</tr>
<tr>
<td>Published</td>
<td>[Read-only] Check box to indicate whether the workflow has been published. Automatically set by the <strong>Publish</strong> action in the workflow menu.</td>
</tr>
<tr>
<td>Description</td>
<td>The purpose of the workflow.</td>
</tr>
</tbody>
</table>

Note: The list shows only tables and database views that are in the same scope as the workflow. Also, all users who edit the workflow must have access to the necessary tables and domains.

Conditions

Create conditions to trigger the workflow. The Conditions section does not appear if you select a table, such as `sc_req_item`, that does not require a condition.
If condition matches

When the condition evaluates to true, the workflow launches an active context:

- **None**: The workflow is not automatically started by the workflow engine. To run this workflow, write a script to start the workflow.
- **Run the Workflow**: The default value. The workflow engine starts the workflow if the information in the Condition field matches a record that is inserting into the table.
- **Run if no other workflows match yet (deprecated)**: The workflow only runs if no other workflows are running on the execution thread that started this workflow. Avoid using.
- **Run if no other workflows matched**: The workflow only runs if no other workflows are running on a specific record. For example, there are four workflows inserted into the Incident table, which have a condition such as `short_desc` contains `test`. A new workflow, which has If condition matches is set to Run if no other workflows match yet, only runs if none of the four workflows have started running on the Incident record.

Condition

A condition builder for specifying workflow conditions that trigger the behavior selected from the If condition matches list.

Order

Numeric value that determines the order of the workflow, relative to other workflows. Workflows are evaluated in order from the lowest order number to the highest. A workflow runs if it is the first to match conditions.

Inputs

The Inputs section lists all the activities in the current workflow that input data, the data type, and the default value. The Inputs section is only available after a workflow has been created. To create a variable, click **New**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displayed column label. Localized depending on user locale.</td>
</tr>
<tr>
<td>Reference</td>
<td>Input field from another table.</td>
</tr>
<tr>
<td>Type</td>
<td>Data type. For example, integer or string.</td>
</tr>
<tr>
<td>Default value</td>
<td>Value used if you do not provide a value.</td>
</tr>
</tbody>
</table>
Activities

The Activities section enables you to set activity pinning and maximum activity count.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Activity pinning | List of options that control updates to custom activities at the workflow level. Pinning protects custom activities from being updated automatically when downloaded from the ServiceNow Store. For more information, see Workflow activity pinning. The possible options are:  
  • **Set by activity:** Allows all activities in the workflow to use their own pinning settings. This is the default pinning option.  
  • **Pin all activities:** Pins all activities in the workflow to their current version.  
  • **Unpin all activities:** Allows all activities in the workflow to be updated. |
| Max activity count| The maximum number of activities performed by the workflow. This value is used to prevent infinite loops and is set to 100 by default. When the stated maximum count is reached, the workflow is canceled. If this field is blank, the maximum count is set to -1, and the workflow is canceled. |

Application

The Application section enables you to see application scope and scope restrictions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>[Read-only] Scope of this activity. For more information, see Application Scope.</td>
</tr>
</tbody>
</table>
| Accessible from  | Scope restrictions for this workflow. Possible settings are:  
  • **All application scopes:** Workflow is accessible to all application scopes.  
  • **This application scope only:** Workflow access is limited to the scope named in the Application field. For more information see Workflow scope. |
## Delivery based on

The schedule type for this workflow. Possible types are:

- **User-specified duration**: Duration based on a user-specified value. This is the default schedule type.
- **Relative duration**: Duration calculated from a preconfigured schedule, such as **8-5 weekdays**.

## Expected time

User-defined interval. This field is visible when the schedule type is **User-specified duration**.

## Schedule

Preconfigured schedule that determines when this workflow runs.

## Timezone

Time zone for this instance.

## Stages

The Stages section appears if you select a table with **Type = Workflow**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stage</td>
<td>Displays the workflow stage progress on the selected table. Optionally, select <strong>Stage rendering</strong> and <strong>Stage orders</strong> schemes to customize the appearance of the stage field. The default values cover typical scenarios.</td>
</tr>
<tr>
<td>Stage rendering</td>
<td>The renderer to use when displaying stage icons on a form or list view. For more information about renderers, see Workflow stage renderers.</td>
</tr>
<tr>
<td>Stage order</td>
<td>The order of workflow stages when you view a workflow field in a list. Select <strong>Computed</strong> to let the workflow engine compute the stage order from the order of execution in the workflow. Select <strong>User Specified</strong> to use the <strong>Order</strong> field from that Workflow stages.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the stage as it appears in workflow fields.</td>
</tr>
<tr>
<td>Duration</td>
<td>Time allocated for the specific stage.</td>
</tr>
<tr>
<td>Order</td>
<td>The order of workflow stages when you view a workflow field in a list. Select <strong>Computed</strong> to let the workflow engine compute the stage order from the order of execution in the workflow. Select <strong>User Specified</strong> to use the <strong>Order</strong> field from that Workflow stages.</td>
</tr>
<tr>
<td>Value</td>
<td>The value of the stage when it is referenced from elsewhere in the system, such as in a script.</td>
</tr>
</tbody>
</table>
Estimated Runtime

The **Estimated Runtime** section opens the controls for configuring the ERT for the workflow. Core workflows included in the base system are not configured for estimated run time by default. All new workflows are configured with default ERT values automatically. You can edit existing run time estimates or configure new ones for any existing workflow. For details about how estimated run times are configured and calculated, see [Workflow run time metrics](#).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requires ERT</td>
<td>Check box to indicate that this workflow requires an estimated runtime configuration. You can use the ERT calculations to determine if workflows are running longer or shorter than expected and to identify errors in workflow processing. By default, new workflows require an ERT.</td>
</tr>
<tr>
<td>Estimated Run Time</td>
<td>The initial estimate for the workflow's run time.</td>
</tr>
<tr>
<td>Number of data points</td>
<td>[Read only] The number of times the system has compared the estimated run time to an actual run time result.</td>
</tr>
<tr>
<td>Outlier Percentage Threshold for ERT</td>
<td>[Required] The percentage deviation from the estimated run time that identifies an outlier workflow run time. The system uses a default value of 20. For more information, see <a href="#">Outlying workflow run times</a>.</td>
</tr>
</tbody>
</table>

Create a workflow from a table

Automate a multi-step process by creating a workflow from the list view of any table that supports workflows.

- If you are designing the workflow as part of an update set process, see [Workflow movement with update sets](#) before creating the workflow.

1. Open a table, such as Incident or Problem, in list view. For example, navigate to Incident > Open.
2. Right-click in the column header and select **Configure > Workflows**.

   ![](image)

   The workflow versions on that table appear in a list.

3. Click **New**.

   The workflow version opens in **New Workflow** view. The **Table** field is filled in with the table you selected in step 1 and is read-only.

4. Enter **Name**.

5. [Optional] Enter **Description**.

6. [Optional] Edit conditions fields as necessary.

7. Click **Submit**.

   The new workflow is added to the **Workflow Versions** list.
8. Click the workflow **Name**.
The new workflow is created with the **Begin** and **End** activities connected by a single transition.

![Workflow diagram](image)

9. Finish creating the workflow by adding activities, validating, and publishing so the workflow is available to other users.
For more information, see [Work on workflows](#).

10. [Optional] To change advanced settings for the workflow, click the **Properties** icon. If you make changes, click **Update**.

---

Create a workflow for a new service catalog item

When you create a new service catalog item, you can create a new corresponding workflow at the same time.

- If you are designing the workflow as part of an update set process, see [Workflow movement with update sets](#) before creating the workflow.

1. Navigate to **Service Catalog** > **Catalog Definitions** > **Maintain Items**.
2. At the top of the form, next to **Catalog Items**, click **New**.

![New button](image)

The Catalog Item form opens.

3. Add a **Name**.
4. Next to the **Workflow** field, click the lookup icon.
5. Next to Workflow at the top, click **New**.

The Workflow version dialog opens in the New Workflow View. The **Table** field is set to **Requested Item (sc_req_item)** and is read-only.

6. Add a **Name**.

7. [Optional] Add a **Description**.

8. [Optional] Change the stage information as necessary.
9. Click **Submit**.
   The new workflow is created with the **Begin** and **End** activities connected by a single transition.

![Workflow Diagram]

10. Finish creating the workflow by adding activities, validating, and publishing so the workflow is available to other users.
    For more information, see **Work on workflows**.
11. To change advanced settings for the workflow, click the **Properties** icon.
12. Click **Update**.
    If you close the Workflow Editor, you can see the Catalog Item record. Note that the workflow is added to the Workflow field. The Show Workflow and Information icons appear next to the **Workflow** field. Hover over the information icon to view a read-only summary of the workflow.

### Create a workflow for an SLA Definition

Automate a multi-step process by creating a workflow from an SLA definition.

- If you are designing the workflow as part of an update set process, see **Workflow movement with update sets** before creating the workflow.

1. Open a list of SLA definitions. For example **Facilities > SLA Definitions** or **Service Level Management > SLA Definitions**.
2. At the top of the form, next to **SLA Definitions**, click **New**.
3. Select **Contract SLA** or **Service Offering SLA**.
   The SLA Definition or Service Offering SLA form opens.
4. Next to the **Workflow** field, click the lookup icon.
5. Next to **Workflow** at the top, click **New**.

The Workflow Version dialog shows in the New Workflow view. The **Table** field is set to **SLA Definition (contract_sla)** or **Service Offering SLA (service_offering_sla)** and is read-only.

6. Enter **Name**.
7. [Optional] Enter **Description**
8. [Optional] Edit conditions fields as necessary.
9. Click **Submit**.
   The new workflow is created with the **Begin** and **End** activities connected by a single transition.

10. Finish creating the workflow by adding activities, validating, and publishing so the workflow is available to other users.
    For more information, see [Work on workflows](#).

11. [Optional] To change advanced settings for the workflow, click the **Properties** icon. If you make changes, click **Update**.

### Ending workflows with multiple branches

A workflow is complete when it reaches the **End** activity, even if there are still active branches of the workflow in progress. To ensure that both branches are completed, add a **Join** activity to resolve the branches.

For example, the following figure shows a workflow with two branches that execute independently. When Task 1 and Task 2 of Branch B are completed, the workflow is marked complete even if the Branch A tasks are not completed.

![Workflow with uncompleted branch](image)
the end. The **Incomplete** condition of the a **Join** activity is met only if one of the branches cannot be completed.

![Diagram of workflow with completed branches]

**Workflow with completed branches**

**Work on workflows**

To complete a workflow, you add workflow activities, validate the workflow, and publish it.

**Add a workflow activity**

Activities determine the functionality of the workflow.

Role required: workflow_admin, workflow_creator, or admin

When they are created, all workflows contain **Start** and **End** activities.

For more information, see Workflow activities.

1. Open a workflow.
2. Check out the workflow.
3. **Drag a workflow activity** from the Activities menu into the workflow body.
4. Populate the Workflow Activity form that appears.

**Validate a workflow**

You can manually validate a workflow from the Workflow Editor. You can generate a workflow validation report from the Workflow Version form.

Role required: workflow_admin, workflow_creator, or admin

Running a workflow on a new node automatically attempts to validate the workflow. If validation is successful, the system updates the workflow version record to indicate the workflow has been validated and marks the record as updated by the user who ran the workflow.

1. Open the workflow to validate in the Workflow Editor.

When the workflow is loaded, the workflow validator icon appears in the toolbar.
2. Click the validator icon to run a series of validation tests on the current workflow version and generate a report.

3. Complete the following steps to generate a workflow validation report from the Workflow Version form
   a) Navigate to **Workflow > Administration > Workflow Versions**, and select a workflow to validate.
   b) Under Related Links, click **Validate Workflow**.

**Publish a workflow**

When a workflow is complete, publish the workflow so that it is available to all users.

Before you publish a workflow, validate it to test it for issues that might cause it to fail, such as missing subflows or disconnected transitions. For more information, see **Workflow validation**.
Role required: workflow_admin, workflow_creator, or admin

To publish a workflow:

1. Navigate to Workflow > Workflow Editor.
2. Open the workflow that you want to publish.
3. In the title bar, click the menu icon and select Publish.

If you published a new version of workflow, the changes are not applied to running workflow contexts. Any currently running workflow context continues using the workflow version that was available when the workflow started. The next time the workflow runs, it uses the new version.

**Determine whether a workflow can run**

A workflow can run only if a checked out version is available to the user who has it checked out, and a valid, published version is available for all users with permission to run it.

Role required: workflow_admin, workflow_creator, or admin

1. In the navigation filter, enter wf_workflow.list, and then open one of the workflows.
2. In the Versions related list, check for all of the following conditions:
   a) There is only one workflow version in a state of Checked out and Checked out by.
   b) There is only one version and it is not checked out. This version must be both Active and Published.
      You may need to personalize the list and add the Active column.
   c) If there are multiple versions, only one is Published.

These checks determine the only two conditions under which a workflow can run:

- A checked out version of a workflow is available for the user who has it checked out.
- A valid, published version of a workflow is available for all users who have permission to run the workflow.

Main flows containing subflows that do not meet one of these two conditions are not permitted to execute against a current record transaction. Instead, a critical log entry detailing the subflow state is added to the Workflow Context record. To enable the workflow to execute on the next appropriate transaction, remove the subflow from the main flow or modify the published and active states of the subflow.

**Edit a published workflow**

You can edit a published workflow after you check it out.

Role required: workflow_admin, workflow_creator, workflow_publisher, or admin

**Note:** You cannot check out or delete workflows that are associated with a read-only application file.

To check out a workflow:

1. Navigate to Workflow > Workflow Editor.
2. Open the workflow that you want to edit.
3. In the title bar, click the menu icon and select **Checkout**.
   
   A new version of the workflow is created and assigned to you.
   
   If you are in a different domain than the published workflow, the new workflow version is **created in your domain**.

After you finish editing the workflow, validate and publish the workflow to make the new version available to other users.

**Copy a workflow between two application scopes**

Application scoping protects applications by identifying and restricting access to application files and data. You can copy a workflow created in one application scope (for example, Test) to another (Production) as needed.

Role required: admin

1. On the Home page, click
   
   located next to the logged in user name.

2. In the **Developer** tab, in the **Application** field, select the application scope (for example, Test) in which you want to operate the ServiceNow platform.

3. Close the System Settings page.

4. Navigate to **Workflow > Workflow Editor**.

5. Create a workflow in the Workflow Editor. For more details, see Create a workflow.

6. In the Workflow Editor, click
   
   located next to the logged in user name.

7. In the **Application** tab, **Application** is set to the current application scope selected in System Settings.

8. In **Accessible from**, select **All application scopes** if the workflow is available to all application scopes, or select **This application scope only** if it is only available to, and accessible in the current application scope only.

   Only those workflows that are accessible from all application scopes can be copied to another application scope.

9. Go back to the Homepage, click

10. In the **Developer** tab, in the **Application** field, select the application scope (for example, Production) to which you want to copy the workflow.

11. Navigate to **Workflow > Workflow Editor**.

12. Refresh the page, then open the same workflow you created.

   An **Out of scope workflow, workflow belongs to <scope name> scope** message appears, where **<scope name>** is the application scope in which the workflow was originally created.

13. In the Workflow Editor, click
14. Select Copy.
   The Workflow Name dialog appears:

   ![Workflow Name Dialog]

   a) In Workflow Name, type the new name for the copied workflow.
   b) Click OK. The system creates a workflow in the current application scope.

15. In the Workflow Editor, click

16. In the Application tab, Application is set to the current application scope.

17. In Accessible from, select This application scope only if to make the newly copied workflow a private one that cannot be accessed from outside current scope.

18. Click Update.

A new workflow record is created in the selected application scope and marked as private if designated as one in the Workflow Editor.

**Workflows used as subflows**

A workflow can launch another workflow as an activity.

The parent workflow triggers the subflow and then waits for the subflow to complete before continuing. Run the workflow validation tool prior to publishing to detect missing subflows and other dependency problems, such as those involving update sets.

The Workflows tab in the Workflow Editor contains a list of the workflows available for use as subflows.
Workflows available to use as subflows

Make sure that the selected subflow is active. If the subflow is inactive, the main workflow will hang with a **Loading** message. If you place an inactive subflow into a workflow, the subflow appears with a red banner, indicating that it cannot run. An active subflow is highlighted in blue when selected.
Subflows and the Create Task activity

If a workflow contains a Create Task activity that has executed on the current record, additional task activities in the workflow might not execute as expected.

This can happen when the same subflow containing a Create Task activity runs more than once in a parent flow. When the subflow reruns and attempts to execute the Create Task activity again, the system reopens the first task activity instead and does not create an additional task.

Note: An alternative to creating duplicate subflows that use the Create Task activity is to add a Run Script activity to the workflow that creates a task with a script.
The same create task activity runs twice in a workflow

In this configuration, the workflow does not run the same subflow containing a **Create Task** activity more than once. This allows the workflow to create additional tasks.
Running different subflows containing the Create Task activity

Pass a variable from a workflow to a subflow

Use this process to pass variables from a parent workflow to a subflow.

Role required: workflow_admin, workflow_creator, or admin

Note: You can also use the Return Value activity in the subflow to return values to the parent workflow. Make sure to have a Return Value on every ending transition path.

1. Prepare the subflow to accept variables from the parent workflow by defining the inputs.
2. Include the subflow in the parent workflow and connect the inputs to the parent workflow variables.

Note: You cannot pass variables to a subflow that runs on the Requested Item [sc_req_item] table.

Define inputs for a subflow

Define the input variables for a workflow to request from parent workflows when it is launched as a subflow.

All inputs are stored in the Variables [var_dictionary] table.

1. In the editor, open and check out the workflow.
2. In the title bar, click the menu icon and select Edit Inputs.
3. In the Workflow Inputs window, click New.
4. Populate the record with the definition of the variable, including the column name, the label that is displayed to the user, and the type of field.

5. Click **Submit**.

*Invoke a subflow in a workflow*

Use this procedure to add a subflow to a workflow.

1. In the Workflow Editor, open and check out the parent workflow.
2. Drag the subflow from the **Workflows** tab to the parent workflow.
3. In the New Activity dialog box, define the variables defined by the subflow's **Inputs**.

   These fields can accept both static values or variables in the following format:

   ```
   $(variable_name)
   ```

4. Click **Submit**.

   The workflow triggers the subflow at the appropriate time and passes the variables as indicated by the **Inputs** definition.

*Prepare a subflow*

Review the process of preparing a subflow for use in a parent workflow, and for preparing the parent workflow to use a subflow.

1. In the editor, open and check out the workflow that you want to use as a subflow.
2. In the title bar, click the menu icon and select **Edit Inputs**.
3. In the Workflow Inputs window, click **New** in the **Variables** list.

4. Add a new variable depending on the type of values that it is going to store.

   The following example sets up a string value.

   ![Example of setting up a string value](image)

5. Click **Submit**.

6. Close the **Workflows Inputs** dialog.
7. Create a **Run Script** activity on the subflow.

- Set the value from the parameter to a field on the current form. This is important because the **Notification** activity can only pull values from the current variable and not from the newly added variable. The following example sets the value in the **Description** field.

  ```javascript
  current.description = workflow.inputs.bluesubvariable;
  ```

- Create a new field on the request form but do not display the field. This serves as temporary storage.
8. Create a Notification activity on the subflow. Use `\{description\}` in the subject to return the value from the field.

This is what the subflow would look like:
Prepare a workflow to use a subflow
After you create a subflow, use this procedure to prepare the parent workflow.

1. On the parent workflow, create a variable similar to what you did on the subflow, but name it something different.

   In the following example, the variable is named **Blue Main Variable**.

2. Click **Submit**.
3. Insert a **Run Script** activity to return the value from a field to the newly created variable.
In this example, the value of the **Short Description** field is returned and given to the newly created variable.

```
workflow.scratchpad.bluemainvariable = current.short_description;
```

4. Click **Submit**.
5. In the subflow activity, set the **Blue Sub Variable** to pass the `bluemainvariable` to the `bluesubvariable`.

   ```
   ${workflow.scratchpad.bluemainvariable}
   ```

   This is what the main workflow looks like:

### Using variables in a workflow

Within workflow there are several different types of variables that are available.

Some variables define, describe, or compose the pieces of the workflow (such as workflow activities). Some variables are available specifically to facilitate the execution of a workflow (such as scratchpad variables). Some variables define, describe, or compose the data records being manipulated by the workflow process (for example, the elements of a Glide Record that are defined in a dictionary.xml file describing a record, such as an incident).

#### Activity variables

Activity variables are properties specifically associated with a workflow activity. These are the inputs that appear on the activity definition when a specific activity is dragged onto the workflow canvas. These variables are properties that define, compose or describe the workflow activity, or the work it is designed to perform.

Activity variables are declared in a related list within the Workflow Activity Definition.

To add, view, or modify a variable:

1. Navigate to **Workflow > Activity Definitions**.
2. Select a workflow activity, such as **Approval - User**.
3. In the **Activity Variables** section or tab, add, view, or modify the variables. Activity variables are defined using the same fields as Dictionary records.

   **Note:** If defining a new activity variable that is dependent on another activity variable, put the prefix "vars." before the name of the parent activity variable. For example, if the child field is dependent on a field named `parent`, put the value `vars.parent` in the **Dependent** field.

   To control the visibility of an activity variable on the workflow canvas after the activity has been dragged to the canvas, use a UI policy on the `wf_activity` table.

   To access the variables or assign values to these variables within the workflow activity, use the `vars` variable of the workflow activity.

   ```
   activity.vars.variable_name = new_variable_value
   ```

### Workflow input variables

Workflow variables are external values that are passed into and referenced by a workflow during its execution.
Workflow variables can be declared externally in a script and passed into a main workflow or they can be declared within a main workflow and passed as inputs to a subflow.

**Note:** There is a specific kind of input variable for any workflow that is declared against the table Requested Item [sc_request_item]. To understand the use of these variables see Workflow catalog variables.

Workflow variables are declared in a form available from the Workflow Editor gear menu.

To add, view, or modify a variable:

1. Navigate to **Workflow > Workflow Editor**.
2. Edit and checkout a workflow.
3. Select the Workflow Activities menu and select **Edit Inputs**.
4. Select an existing variable or click **New**.

Note the **Column name** field. Use this value when accessing the variable from a script.

Workflow variables do not appear on the workflow canvas, they are only available for view from the Workflow Activity menu.

The input variables are available to use in scripts. To access an input variable from a script:

```javascript
var input = workflow. variables. variableName //get the workflow variable identified by column name.
```

### Assigning values to variables from outside of workflow

After being declared in a workflow, values can be assigned to the variables from where the workflow is kicked off.

The following example demonstrates how a workflow variable's value can be set in a script include, business rule, or UI action:

```javascript
//Declare an instance of workflow.js
var wf = new Workflow(); //Get the workflow id
var wfId = wf.getWorkflowFromName( "Workflow Name" );

//Start workflow, passing along name : value pair(s) for mapping to variable
//where input_var_name is the name of the variable declared in gear menu
//and input_var_value is whatever that value should be for this execution of workflow
wf.startFlow(wfId, null, "Workflow Name", {input_var_name: input_var_value });
```

Another example that demonstrates a more readable way of passing multiple variables involves declaring an object, adding the names/values to the object, and passing it:

```javascript
//Declare an instance of workflow.js
var wf = new Workflow();

var vars = { };
vars. input_var_name1 = input_var_value1;
vars. input_var_name2 = input_var_value2;

// add as many variables as your workflow is expecting, then pass the object
```
Assigning Values for Subflow Inputs from inside of a Main Workflow

If a workflow that accepts inputs is called from within another workflow, those input values can be set from the workflow canvas within the UI of the workflow activity. Each input variable declared for a subflow will have a text box input area displayed on the activity. Within these text boxes, the variables can be set with any value either from the scratchpad or from within the current record.

For more information, see Workflows used as subflows.

Reading the Value of a Workflow Input Variable

The value of a Workflow input variable is accessible anywhere within the workflow that accepts javascript by dot walking the current workflow object:

```
var readValue = workflow.inputs.variable_name;
```

Workflow scratchpad variables

Store and share string-based variables as name-value pairs between workflow activities.

The scratchpad is global to the instance of the running workflow and as such, is available equally to all activities.

Declaration

The scratchpad itself is automatically available to an executing workflow and requires no specific declaration. Variables are declared and stored in the scratchpad simultaneously by referencing it. For example:

```
workflow.scratchpad.variableName = variableValue;
```

Display

View activity scratchpad values from the Workflow Activity History Scratchpad [wf_history_scratchpad] table. Workflow Activity History Scratchpad is also an embedded list in Worklfow Activity History records.
Sample Workflow Activity History Scratchpad records
Access and Assignment

Use standard JavaScript object notation to access or assign scratchpad values. For example, use this format to assign a particular scratchpad variable value.

```javascript
workflow.scratchpad.variableName = variableValue;
```

Use this format to assign a JavaScript variable to a scratchpad variable.

```javascript
var myValue = workflow.scratchpad.variableName;
```

Current variables

Current is the database GlideRecord that kicked off the workflow, either by association to the table in the Workflow properties table or by being associated with a catalog item.

Declaration

Variables in current are the columns that are defined in the `dictionary.xml` file that support the database record. There is no way at runtime to add variables to the current record.

Display

Variables of a current record are displayed on the Glide Forms and Lists throughout the applications that use them.

Access and Assignment

To access the variables or assign values to the variables within the workflow activity, get the value from the current record by referencing the Glide Element.

```javascript
var myVarValue = current.getElement(nameOfTheField);
```

or

```javascript
var myVarValue = current.fieldName;
```

or

```javascript
current.variableName.setValue( "A Variable Value");
```

Workflow catalog variables

Workflows that are associated with the Requested Item `[sc_req_item]` table have a specific type of workflow input.

The inputs into this workflow are essentially question:answer pairings that, when associated with a specific catalog task, become options on the task form. These options are generated by that catalog task activity within a workflow.
Scope

For the purposes of Service Catalog and workflow, a variable’s scope determines its availability to a catalog task activity within a workflow. You can define variables as global or catalog item-specific. When a variable is associated to a catalog item and the workflow generating the catalog task is associated to the catalog item, the variable scope determines which variables are available for mapping within the catalog task activity in a workflow. If a workflow is associated with Requested Item [sc_request_item], and is not specifically associated with a catalog item, any catalog variable with a blank Cat Item field value is available to all catalog task activities within the workflow.

Declaration

You can declare requested item catalog variables at the catalog item level or at a global level.

You can declare global catalog variables using the Workflow Editor context menu.

Also see, Global variable declaration option 2.

1. Navigate to Workflow > Workflow Editor.
2. Open and check out a workflow that runs against the Requested Item [sc_req_item] table.
3. Click the menu icon and select Edit Catalog Variables.
4. Click New to create a new variable or select an existing variable.
5. Select the Global check box.
6. Click Submit.

Global variable declaration option 2
You can declare global catalog variables using the Service Catalog.

1. Navigate to Service Catalog > Item Variables.
2. The list of variables that appears in the workspace has a default filter of Cat Item != <blank>. Change the filter to Cat Item = <blank> and run the query.
   The catalog variables that appear are available to any catalog task that is initiated from within a workflow.
3. Click New to create a new variable.
4. Leave the Cat Item field blank.
5. Select the Global check box.
6. Click Submit.

   Also see, Global variable declaration option 1.

Catalog item specific variable declaration option 1
You can declare a catalog item-specific variable.

These variables are only available to the catalog item referenced in the Cat Item field on the variable record.

1. Navigate to Service Catalog > Catalog Variables > Item Variables.
   Note the list of variables that appears in the workspace has a default filter of Cat Item != <blank>.
2. Enter or select a catalog item in the Cat Item reference field.
   Selecting a Cat Item restricts the scope and availability of the catalog variable to that specific catalog item.
3. Click Submit.
   Also see, Catalog item specific variable declaration option 2.

Catalog item specific variable declaration option 2
You can declare a catalog item-specific variable directly from a catalog item record.
Creating a catalog variable in this way automatically sets the **Cat Item** reference to the catalog item selected.

1. Navigate to **Service Catalog > Catalog Definitions > Maintain Items**.
2. Select or create an a catalog item.
   - Note the **Variables** related list. All variables declared using this related list have a **Cat Item** reference value of the current catalog item.
3. From the **Variables** related list, click **New**.
4. Ensure that the **Cat Item** field correctly references the catalog item previously selected or created.
5. Go to or open the **Question** section or tab.
6. Add a **Question**.
7. Add a **Name**.
   - Variable names should not include white space and cannot begin with a number.
8. Click **Submit**.
   - Also see, **Catalog item specific variable declaration option 1**.

**Display**

Catalog specific item variables are visible in several places depending on where in the process the variable is viewed.

Declaration can happen and variables can be seen from within the menu, inside both the **Maintain Items** module and in the **Item Variable** modules of the Service Catalog.

Within a workflow, the Catalog Specific Item variables are available to the **Catalog Task** activity in the form of a slushbucket at the bottom of the **Catalog Task** activity. Item variables that are selected, are the question and answer pairs that will appear on the task that is generated by that instance of **Catalog Task** when executing that workflow.

If a workflow is associated with a specific catalog item, the association acts as a filter for item variables that appear in the slushbucket of the **Catalog Task** activity.

The last place the variables are seen is in the task form that is generated by the Catalog Task Item. The variables selected in the slushbucket are the question and answer pairs that appear to the user on the task form.

**Access and assignment**

The Catalog Item Variables are available and assigned to a specific **Catalog Task** activity (thereby to a specific task) using the slushbucket entry of a catalog task.

The user working the task enters the values of the variables.

To access the values of a Catalog Item Variable inside a script:

```javascript
var now_GR = current; // or create and query a new GlideRecord
var itemVariable = now_GR. variables [ variableName ]; //access the service catalog variable identified by the variable name.
var itemVariableValue = itemVariable. getValue ();
var itemVariableName = itemVariable. getName ();
var itemQuestion = itemVariable. getQuestion (); //All GlideappQuestion API are accessible on itemQuestion
```

**Workflow events**

The system employs two types of events: registered platform events and workflow events.
Registered platform events

Registered events are created in business rules and are used for such tasks as sending email notifications when records are inserted into the database. Workflow events are registered within workflows only and are not used anywhere else in the platform. Registered platform events can be triggered by a workflow for external use, but cannot be used within a workflow.

Workflow events

Workflow events follow different rules than platform events that are registered using the event registry. Platform events are entered into the Event Registration [sysevent_register] table and are available for platform processes to use. Workflow events are triggered exclusively for the workflow engine and are used only to direct the work of executing workflow contexts. When an event is registered in a workflow, it is attached to a currently executing activity in the registered_events column of the Workflow Executing Activity [wf_executing] table.

Workflow events also can be broadcast to a workflow from any scripting source that has access to the workflow context, such as a script include or a Run Script activity. In this case, the event, such as cancel, is passed to all records in the Workflow Executing [wf_executing] table for a specific context.

Whether by registry or by broadcast, an event is handled by the activity definition associated with the currently executing activity. Each activity definition comes with a set of handlers. For example, most activities come with onExecute, onCancel, and onUpdate event handlers. As an example of a more specific event, the Approval - User activity also comes with onDetermineApprovalState, which is specific to the work of the approval activity.

Multiple parallel events

A single workflow can have multiple event threads running concurrently, such as when a workflow has timers that overlap on separate workflow branches. If any additional thread completes before the first thread, the system stores event information from the additional thread on the Workflow Queued Commands [wf_command] table. After the first thread completes, the system retrieves the information stored by the additional thread and proceeds through the workflow with the event information from each thread.

Workflow events in the base system

Several workflow events are available in the base system.
### Workflow events in the base system

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Purpose</th>
<th>To use</th>
<th>Source</th>
<th>Thread</th>
<th>Listeners</th>
</tr>
</thead>
<tbody>
<tr>
<td>activityComplete</td>
<td>String value used by activity definitions to respond to the onActivityComplete event handler.</td>
<td>Informs records in the Workflow Executing Activity [wf_executing] table about the completion of other activities in the same workflow context.</td>
<td>If the activity is allowed to set the boolean value for workflow Engine, Process Terminations <code>wf_executing.notify_termination</code>, then set the value to <code>true</code> during the onExecute event.</td>
<td>Current thread, current mutex</td>
<td>Join activity</td>
<td></td>
</tr>
<tr>
<td>otherEvent</td>
<td>String value used by the Join activity to respond to an otherEvent.</td>
<td>Informs records in the Workflow Executing Activity [wf_executing] table about an otherEvent that has completed.</td>
<td>The Join activity transitions from <code>n</code> number of preceding activities. These preceding activities all create a <code>wf_executing</code> record, which causes a check to see if the record already exists. If the Join already exists, then the Join created by the executing transition sets the <code>wf_executing</code> record for deletion.</td>
<td>Join activity</td>
<td>Current thread, current mutex</td>
<td>Join activity, onOtherEvent event handler</td>
</tr>
<tr>
<td>Event</td>
<td>Description</td>
<td>Purpose</td>
<td>To use</td>
<td>Source</td>
<td>Thread</td>
<td>Listeners</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>timer</td>
<td>String value used by workflow activities to respond to a Timer activity that has expired.</td>
<td>Allows wf_executing records to be informed about a timer activity that has completed and has fired the timer event.</td>
<td>The Timer activity schedules a job that calls a script. The script calls fireEvent (wf_executing, timer).</td>
<td>Timer activity via a scheduled job</td>
<td>Worker thread, private mutex</td>
<td>Timer activity, onTimer event handler</td>
</tr>
<tr>
<td>execute</td>
<td>String value used by workflow activities to respond to a Timer activity that has expired.</td>
<td>Informs a record in the wf_executing table with the initial state of Executing to proceed with its primary work.</td>
<td>The workflow engine, for each transition executed, creates an executing record with a state of Executing. Once created, the executing record is put in a queue for processing. For each item in the queue, the Rhino globals are established, the activity definition that drives the executing record is instantiated, and the run() function is called. When the state of a record is Executing, this function always calls onExecute.</td>
<td>Workflow engine, via the WFActivity Handler</td>
<td>Current thread, current mutex</td>
<td>All activities, onExecute event handler</td>
</tr>
<tr>
<td>Event</td>
<td>Description</td>
<td>Purpose</td>
<td>To use</td>
<td>Source</td>
<td>Thread</td>
<td>Listeners</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>--------</td>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>execute (specific to Lock)</td>
<td>String value used by the Lock activity to respond to a waiting lock that is ready to make another attempt to obtain a specific lock. This execute is different than the previous execute because it is called on a separate thread, at specified intervals, and is treated as an outside event.</td>
<td>Informs a wf_executing record waiting to execute that the specified wait interval has passed and that it should attempt to get the lock again.</td>
<td>Lock activity schedules a job with a script that uses the workflow script include's fireEvent(wf_executing, 'execute') method.</td>
<td>Lock activity via a scheduled job</td>
<td>Worker thread, private mutex</td>
<td>Lock activity, onExecute event handler</td>
</tr>
<tr>
<td>determineApprovalState</td>
<td>String value used by approval activities to respond to a change in the overall approval status of the current record.</td>
<td>Informs wf_executing records for approval activities about an approval that completed and triggered the timer event.</td>
<td>Approval Coordinator both registers for the event and triggers the event. The child approvals have listeners that determine their approval state.</td>
<td>Approval Coordinator triggers the event during its onExecute event</td>
<td>Current thread, current mutex</td>
<td>Approval Coordinator, Approval - User, and Approval - Group all have onDetermineApprovalState event handlers. If the state is anything but Requested, the activity is considered finished, and the approval state (Approved, Rejected, Cancelled) is set to the wf_executing.result column</td>
</tr>
<tr>
<td>Event</td>
<td>Description</td>
<td>Purpose</td>
<td>To use</td>
<td>Source</td>
<td>Thread</td>
<td>Listeners</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>--------------</td>
<td>---------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>cancel (from within activity</td>
<td>String value used by workflow activities to respond to a request for</td>
<td>Informs all wf_executing records in a context that the workflow is being</td>
<td>The <strong>End</strong> activity uses the global <code>workflow.broadcastEvent('cancel')</code> to interrupt the currently running wf_executing records. This changes the state of those records to <strong>Cancelled</strong>.</td>
<td><strong>End</strong> activity</td>
<td>Current thread, current mutex ('cancel')</td>
<td>All activities, <strong>onCancel</strong> event handler</td>
</tr>
<tr>
<td>definitions)</td>
<td>cancellation.</td>
<td>canceled.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Purpose</th>
<th>To use</th>
<th>Source</th>
<th>Thread</th>
<th>Listeners</th>
</tr>
</thead>
<tbody>
<tr>
<td>cancel (outside current</td>
<td>String value used by workflow activities to respond to a request for cancellation.</td>
<td>This event is the same as the cancel event above and handled the same. However, the management of this event is subtly different. This event informs all wf_executing records in a context that the workflow is being canceled. The event is managed via the onCancel event handler of each executing activity definition, but the event is called differently. In particular, the call to cancel from outside an activity definition is blocked by the current mutex. This is a significant difference in that the event does not interrupt a currently executing activity that is still operating within the parameters of the current mutex.</td>
<td>Any script can call cancel on a known executing context via the workflow script include. For example, var w = new Workflow(); w.cancel(context); // where context is a GlideRecord of the context to be canceled.</td>
<td>Any script include, scheduled job, UI action, or other source</td>
<td>Current thread, private mutex</td>
<td>All activities, onCancel event handler</td>
</tr>
<tr>
<td>Event</td>
<td>Description</td>
<td>Purpose</td>
<td>To use</td>
<td>Source</td>
<td>Thread</td>
<td>Listeners</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>stop (see End</td>
<td>The <strong>End</strong> activity checks for this event.</td>
<td>If the stop event is the current event, then the cancel operation of the <strong>End</strong> activity is bypassed.</td>
<td>Only in the <strong>End</strong> activity.</td>
<td>Any script can trigger or broadcast the stop event via a script include or workflow Run Script activity</td>
<td>Current thread, current mutex</td>
<td>This event is used by the <strong>End</strong> activity to exclude the <strong>Cancel</strong> activity and allow a workflow to end, even if canceled.</td>
</tr>
<tr>
<td>listener</td>
<td>String value that the workflow (subflow) activity triggers as an event.</td>
<td>When a main workflow calls a subflow, the workflow keeps the ID of the subflow’s context in the scratchpad. When the subflow is complete, it triggers the listener event via a business rule.</td>
<td>The listener event is passed to the parent context on completion of a subflow and is managed by the onListener action of the workflow activity.</td>
<td>Business rule that is triggered by the update of a workflow that has a parent</td>
<td>Current thread, current mutex</td>
<td>This event is used by a subflow to inform it's parent flow that it is complete. The parent workflow will react to this event and continue.</td>
</tr>
<tr>
<td>probe_complete</td>
<td>String value triggered in the workflow by an Orchestration activity indicating that the MID Server has completed a task.</td>
<td>The <strong>probe_complete</strong> event is triggered from Orchestration sensor processors via the workflow helper function <code>handleEventById</code>.</td>
<td>Event used to restate a workflow that is waiting for the MID Server to process a task or activity</td>
<td>Worker thread, private mutex</td>
<td>Orchestration activities</td>
<td></td>
</tr>
<tr>
<td>pause</td>
<td>String value sent to a workflow from an SLA to pause the <strong>Timer</strong> activity.</td>
<td>When an SLA is paused, the SLA workflows must be paused if there is a timer running.</td>
<td>Use is exclusive to the SLA timer</td>
<td>SLA</td>
<td>Business rule thread, private mutex</td>
<td><strong>Timer</strong> activity</td>
</tr>
</tbody>
</table>
### Glide events relative to workflows

Workflow uses several Glide events.

#### Workflow Glide events

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Purpose</th>
<th>To use</th>
<th>Source</th>
<th>Thread</th>
<th>Listeners</th>
</tr>
</thead>
<tbody>
<tr>
<td>resume</td>
<td>String value used by the <strong>Timer</strong> activity to resume a paused timer (see pause). When an SLA is resumed, the SLA workflows must be resumed as well.</td>
<td>Use is exclusive to the SLA timer.</td>
<td>SLA</td>
<td>Business rule thread, private mutex</td>
<td><strong>Timer</strong> activity</td>
<td></td>
</tr>
</tbody>
</table>

**Glide events relative to workflows**

Workflow uses several Glide events.

#### Workflow Glide events

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Purpose</th>
<th>To Use</th>
<th>Source</th>
<th>Thread</th>
<th>Listeners</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>Global event set upon the insert of a GlideRecord that causes the script engine, and through that the workflow engine, to wake up. Starts workflows that are associated with the current GlideRecord either by reference, as in request items and SLA timers, or by conditions associated with the GlideRecord's table.</td>
<td>There is no explicit customer-facing use for this in a workflow. It is part of the Glide engine, and with this event, the only thing workflows can do is start. Workflows can also be started manually using a script.</td>
<td>Workflow Engine, RunEngine</td>
<td>Current thread, current mutex</td>
<td>User action of insert</td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>Global event set upon the update of a GlideRecord that causes the script engine, and through that the workflow engine, to wake up. Looks to the Workflow Context [wf_context] table to find running workflows that are associated with the current GlideRecord by document ID.</td>
<td>There is no explicit customer-facing use for this in a workflow. It is part of the Glide engine, and with this event, the only thing workflows can do is advance through the next set of transitions.</td>
<td>Workflow Engine, RunEngine</td>
<td>Current thread, current mutex</td>
<td>User action of update of a GlideRecord</td>
<td></td>
</tr>
<tr>
<td>Event</td>
<td>Description</td>
<td>Purpose</td>
<td>To Use</td>
<td>Source</td>
<td>Thread</td>
<td>Listeners</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td>---------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>-----------</td>
</tr>
<tr>
<td>Delete</td>
<td>Global event set upon the delete of a GlideRecord that causes the script engine, and through that the workflow engine, to wake up.</td>
<td>Looks to the Workflow Context [wf_context] table to find running workflows that are associated with the current GlideRecord by document ID.</td>
<td>There is no explicit customer-facing use for this in a workflow. It is part of the Glide engine, and with this event, the only thing workflows can do is advance through the next set of transitions.</td>
<td>Workflow Engine, RunEngine</td>
<td>Current thread, current mutex</td>
<td>User action of delete of a GlideRecord</td>
</tr>
<tr>
<td>Query</td>
<td>Global event set upon the query of the Glide database that causes the script engine, and through that the workflow engine, to wake up.</td>
<td>Looks to the Workflow Context [wf_context] table to find running workflows that are associated with the current GlideRecord by document ID.</td>
<td>There is no explicit customer-facing use for this in a workflow. It is part of the Glide engine, and with this event, the only thing workflows can do is advance through the next set of transitions.</td>
<td>Workflow Engine, RunEngine</td>
<td>Current thread, current mutex</td>
<td>User action of query of a GlideRecord</td>
</tr>
</tbody>
</table>

*Workflow event-specific functions*

There are several functions that relate specifically to workflow events.
## Workflow event-specific functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Purpose</th>
<th>Use</th>
<th>Thread</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>registerForEvent(eventName)</td>
<td>Function in the workflow environment that writes events represented as strings to the <code>wf_executing.registered_events</code> field.</td>
<td>The workflow events are just strings. When an activity that has registered for an event executes, a comma-delimited set of events is stored with the Workflow Executing Activity <code>[wf_executing]</code> record. When the event is triggered in the workflow context, the <code>wf_executing</code> table looks for all executing records that contain the string that represents the event in the <code>wf_executing.registered_events</code> field.</td>
<td>The global variable workflow that is available to all Workflow Activity <code>[wf_activity]</code> records is the source of the call. For example, from inside a Run Script activity, a designer can write: <code>workflow.registerForEvent('myEventName');</code></td>
<td>Current thread, current mutex</td>
<td>Global variable workflow</td>
</tr>
<tr>
<td>unRegisterForEvent(eventName)</td>
<td>Function in the workflow environment that removes a string value representing an event that has been written to the <code>wf_executing.registered_events</code> field.</td>
<td>The workflow events are just strings that are written to the <code>wf_executing.registered_events</code> field. When an activity unRegisters for an event, the comma-delimited set of events stored with the Workflow Executing Activity <code>[wf_executing]</code> record is searched, and if that string is found, it is removed.</td>
<td>The global variable workflow that is available to all Workflow Activity <code>[wf_activity]</code> records is the source of the call. For example, from inside a Run Script activity, a designer can write: <code>workflow.unRegisterForEvent('myEventName');</code></td>
<td>Current thread, current mutex</td>
<td>Global variable workflow</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Purpose</td>
<td>Use</td>
<td>Thread</td>
<td>Source</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>---------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td><code>fireEvent(eventName)</code></td>
<td>Function in the workflow environment that examines the contents of the <code>wf_executing.registered_events</code> field, comparing its contents to the <code>eventName</code> passed in.</td>
<td>The workflow events are just strings that are written to the <code>wf_executing.registered_events</code> field. When <code>fireEvent(eventName)</code> is called by a workflow activity, the workflow engine queues up any executing records that contain the string in the registered field.</td>
<td>The global variable workflow that is available to all Workflow Activity records is the source of the call. For example, from inside a Run Script activity, a designer can write: <code>workflow.fireEvent('myEventName');</code></td>
<td>Current thread, current mutex</td>
<td>Global variable workflow</td>
</tr>
<tr>
<td><code>fireEvent(eventRecord, eventName)</code></td>
<td>Function in the workflow environment that sends an event to a specific Workflow Executing Activity <code>[wf_executing]</code> record. The <code>eventRecord</code> is a GlideRecord of the type <code>[wf_executing]</code>.</td>
<td>This event call expects an <code>onMyEvent</code> event handler in the activity represented in the event record (Workflow Executing Activity <code>[wf_executing]</code> table). When <code>fireEvent(eventRecord, eventName)</code> is called by a workflow activity, the workflow engine queues up the specific executing record with that event and passes the event into the activity definition for the <code>on&lt;eventName&gt;</code> handler to manage. This event is queued up in its own mutex, so the current queue completes before this event is processed.</td>
<td>The workflow script include contains the call for this. For example, from inside a Run Script activity, a designer can write: <code>var w = new Workflow(); w.fireEvent(executing, eventName);</code></td>
<td>Current thread, current mutex</td>
<td>Workflow script include</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Purpose</td>
<td>Use</td>
<td>Thread</td>
<td>Source</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>fireEvent</td>
<td>Function in the workflow environment that sends an event to a specific Workflow Executing Activity [wf_executing] record. The eventRecordSysId is the sys_id of a GlideRecord of the type wf_executing.</td>
<td>This is the same as the fireEvent above, except that it accepts an ID and returns the Workflow Executing Activity [wf_executing] record.</td>
<td>The Workflow script include contains the call for this. For example, from inside a Run Script activity, a designer can write: var w = new Workflow(); w.fireEvent(executing, eventName);</td>
<td>Current thread, current mutex</td>
<td>Workflow script include</td>
</tr>
<tr>
<td>fireEvent</td>
<td>Function in the workflow environment that sends an event to a specific Workflow Executing Activity [wf_executing] record. The eventRecordSysId is the sys_id of a GlideRecord of the type wf_executing.</td>
<td>This is the same as the fireEvent above, except that it accepts a JSON object as a third parameter. This object can specify any data expressible as JSON. You can also specify additional functionality when creating a workflow activity.</td>
<td>The Workflow script include contains the call for this. For example, from inside a Run Script activity, a designer can write: var w = new Workflow(); w.fireEvent(executing, eventName, JSONObject);</td>
<td>Current thread, current mutex</td>
<td>Workflow script include</td>
</tr>
<tr>
<td>broadcastEvent</td>
<td>Function in the workflow environment that sends an event to all currently running Workflow Executing Activity [wf_executing] records in a specified context, regardless of their state.</td>
<td>This is the same as the fireEvent above, except that it accepts an ID and returns the Workflow Executing Activity [wf_executing] record.</td>
<td>The Workflow script include contains the call for this. For example, from inside a Run Script activity, a designer can write: var w = new Workflow(); w.bROADCASTEvent(contextId, eventName);</td>
<td>Current thread, current mutex</td>
<td>Workflow script include</td>
</tr>
</tbody>
</table>
### Event-specific workflow activities

The following workflow activities trigger events.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Purpose</th>
<th>Use</th>
<th>Thread</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>broadcastEvent(eventName)</td>
<td>Function in the workflow environment that sends an event to all currently running Workflow Executing Activity [wf_executing] records in the current context, regardless of their state.</td>
<td>This should not be confused with broadcastEvent above. This event is only available to current Workflow Executing Activity [wf_executing] records.</td>
<td>This is available only through the global workflow variable of the current context. The following is an example of its use from within an activity definition's script: <code>workflow.broadcastEvent(eventName)</code></td>
<td>Current thread, current mutex</td>
<td>Global variable workflow</td>
</tr>
</tbody>
</table>
## Event-specific workflow activities

<table>
<thead>
<tr>
<th>Activity Name</th>
<th>Description</th>
<th>Purpose</th>
<th>To Use</th>
<th>Source</th>
<th>Thread</th>
<th>Listeners</th>
</tr>
</thead>
</table>
| Create Event  | Requires an event from the event registry rather than a workflow event. This activity is located in the Notification category of the workflow tree. | Fires the notification event specified in the Workflow Activity [wf_activity] table. | 1. Navigate to System Policy > Events > Registry  
2. Create an event.  
3. Navigate to System Policy > Templates and create an email template.  
4. Navigate to System Policy > Email > Notifications.  
5. Create a new notification that is triggered by the event you created and sends the template you created.  
6. On the workflow canvas, drag the Create Event activity onto the canvas and associate it with the event. | Event Registry | Triggered in the current thread and handled on the worker thread in notifications. Never processed by a workflow | On the notification thread, outside of workflow |
<table>
<thead>
<tr>
<th>Activity Name</th>
<th>Description</th>
<th>Purpose</th>
<th>To Use</th>
<th>Source</th>
<th>Thread</th>
<th>Listeners</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait for WF Event</td>
<td>Listens for workflow events, as described in the Workflow Events in the Base System table, and only within the current context. This activity is located in the Conditions category of the workflow tree.</td>
<td>Waits for another transition branch of the current context to trigger an event.</td>
<td>Takes an event name as input. When the activity is executed, the specified event name is added to a string array stored in the registered_events column. The values in this column are in a list of all events the activity waits for when it is executing.</td>
<td>The Wait for WF Event activity has a generic onUnhandledEvent that tests the current event against the value that was passed to the variable. If they match, the Wait for WF Event activity moves the workflow forward.</td>
<td>Triggered in the current thread or from a script include</td>
<td>The onUnhandledEvent of the Wait for WF Event activity</td>
</tr>
</tbody>
</table>

**Workflow stages**

Workflows can indicate workflow progress by updating any field designated as a stage field.

For example, the Incident [incident] table has an **Incident state** field that indicates progress, but the service catalog uses the **Stage** field.

To indicate the workflow's progress through the possible stage values, the interface updates the **Stage field** selected in the workflow properties. Available fields depend on the table used by the workflow. If the field provides a choice list, then the choices are available as stage values for the workflow. If the field is a workflow field, it displays an icon to indicate the workflow's progress, as with the Service Catalog's **Stage field**.
Service Catalog Stage field with icons

After stages are added to the workflow, they can be assigned to each workflow activity. If an activity with an assigned stage is encountered when the workflow runs, the workflow engine assigns the stage to the record associated with the workflow context.

For workflows that use the Requested Item [sc_req_item] table, the stage field is automatically set to the Stage field of the table and cannot be changed. The stage state displayed for a workflow running on the Requested Item table is based on the state of the workflow activities.

- If an activity is active, then the stage is shown with the state of *In progress*.
- If an activity is in the *Pending* or *Completed* state, the stage reflects this state.
- If an activity is canceled, *Request Cancelled* appears in the Stage field. The "Cancelled" label set in the wf_stage table is a reserved word, and does not display in the Stage field.

**How stage values are derived**

Stage values are derived from various sources in the interface.

- **Note:** An updated method for managing workflow stages as a set is also available. For information about grouping and reusing stages, see Workflow stage sets.

Stage values are derived from the following sources:

- **Choices for Stage column:** Choices defined for the column selected as the Stage column for the workflow.
- **Default stages for table:** Stages defined in the Stage Default [wf_stage_default] table for the table selected.
- **Workflow-specific stages:** Applied only to the workflow for which they were defined in the Workflow Stage [wf_stage] table.
- **Stage values in existing records:** Values from the designated Stage column in the table assigned to the workflow are inherited from existing records.

If the stage field for a workflow is the table column named Stage, then the progress of the workflow appears in any list view containing the Stage column.
Stages in a list

Stage values shown in the list views are accompanied by the state, based on the workflow activities being executed. If an activity has a stage specified for it, and the activity is currently active in the workflow, then the stage is shown with a state of **In progress**. Similarly, if the activity is in the **Pending** or **Completed** state, the stage reflects this state.

**Example**

If the workflow table is Request Item [sc_req_item], then the stage field is automatically set to the **Stage** column of that table and cannot be changed. The following stage values for the request item are displayed in a choice list from the Dictionary Entry [sys_dictionary] table:

- Waiting for Approval
- Fulfillment
- Delivery

In addition, the Request Item table has the following default stages:

- Request Cancelled
- Completed

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Note:** If an activity is cancelled, Request Cancelled appears in the **Stage** field. The "Cancelled" label set in the `wf_stage` table is a reserved word, and does not display in the **Stage** field.

When you edit available activity stages in the Workflow Editor, the list displays the following stage values:

- Waiting for Approval
- Fulfillment
- Delivery
- Request Cancelled
- Completed

The following diagram depicts the process used to gather stage values from the Request Item table to populate the **Stages** list in workflow activities.
Note: If you are creating a workflow with a table other than Request Item [sc_req_item], you must select a **Stage field** in the workflow properties for the workflow to have stages.

**Use workflow stages**

You can add or modify workflow stages.

Role required: workflow_admin, workflow_creator, or admin

1. Navigate to **Workflow > Workflow Editor**.
2. Create a new workflow by clicking **New** or open an existing workflow.

3. In the Workflow Properties form, if the table is not the Requested Item [sc_req_item] table, select a field to display stages in the **Stage** field property.

   **Available fields** depend on the table selected for the workflow.

4. After assigning a list of stages to the workflow, you can set a stage value in any of the workflow activities that provide a **Stage** field in their dialog box.

   Setting a stage value in a workflow activity tells the workflow engine to assign that stage to the record associated with the workflow context when the activity is encountered during a run.

   When an activity starts with a specified stage, the platform updates the **Stage** field with the current value. In workflows run against the Requested Item [sc_req_item] table, the `sc_req_item.stage` field is defined as a workflow type field.

   When displaying the stages for a workflow on the Requested Item [sc_req_item] table, the stage state is based on the state of the workflow activities. If an activity has a stage specified for it, and the activity is currently active in the workflow, then the stage is shown with an **In progress** state. Similarly, if the activity is in the **Pending** or **Completed** state, the stage reflects this state.

5. To edit the workflow-specific stages for an existing workflow, click the gear icon in the header bar and select **Edit Stages**. Again, these stage values are combined with the choices, defaults, and existing values.
Workflow stages
To optimize the use of stages, you can assign a stage to multiple activities in a workflow. For example, if your workflow uses the following activities to create tasks:

1. Get approval
2. Order equipment
3. Receive equipment
4. Add equipment to CMDB
5. Set up equipment
6. Install software
7. Configure software
8. Deliver to user

The following stages might be used:
- Approval
- Order
- Configure
- Deliver

A good practice is to assign stages to the activities as follows:

<table>
<thead>
<tr>
<th>Activity</th>
<th>Assigned stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get approval</td>
<td>Approval</td>
</tr>
<tr>
<td>Order equipment</td>
<td>Order</td>
</tr>
<tr>
<td>Receive equipment</td>
<td>Order</td>
</tr>
<tr>
<td>Add equipment to CMDB</td>
<td>Order</td>
</tr>
<tr>
<td>Set up equipment</td>
<td>Configure</td>
</tr>
<tr>
<td>Install software</td>
<td>Configure</td>
</tr>
<tr>
<td>Configure software</td>
<td>Configure</td>
</tr>
<tr>
<td>Deliver to user</td>
<td>Deliver</td>
</tr>
</tbody>
</table>

When the Order equipment, Receive equipment, or Add equipment to CMDB activity is active, the Stage display shows that the Order stage is In progress.

Add and translate stages
You can add default stages to use for a table, and stages to existing workflow
Add default stages for a table
You can assign a stage set as a default set to any number of tables.

The stages in the assigned stage set pre-fill the workflow version stages when you create a new workflow for the associated table.

1. Navigate to Workflow > Default Stages (by table).
2. Click **New**.
3. Select a stage **Set**.
   You can create a new set by clicking **New**, typing a name, and clicking **Submit**.
4. Select a corresponding **Table**.
5. Click **Submit**.
   The stages in the selected stage set are automatically added to any new workflows that use the corresponding table.

**Add a stage to an existing workflow**
If a stage required for a workflow has not been imported or is not in the stage set assigned to the workflow table, you can add it to the workflow manually.

1. Navigate to **Workflow > Workflow Editor**.
2. Open and check out the workflow.
3. In the title bar, click the menu icon and select **Edit Stages**.
4. In the Workflow Stages list, click **New**.
5. On the Workflow Stage form, fill in the fields as appropriate.
   Do not use a **Name** or **Value** field value that already exists in the base system.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the stage as it appears in workflow fields.</td>
</tr>
<tr>
<td>Value</td>
<td>The value of the stage when it is referenced from elsewhere in the system, such as in a script.</td>
</tr>
<tr>
<td>Duration</td>
<td>The default duration for the stage. Currently not used.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.
7. Publish the workflow.

**Add a stage to a workflow activity**
After stages are added to a workflow, you can assign them to the workflow activities.

1. Navigate to **Workflow > Workflow Editor**.
2. Open and check out the workflow.
3. Double-click the activity.
4. In the **Stage** field on the Activity Properties form, find and select the stage to display when the workflow reaches the activity.
5. Click **Update**.

**Translate workflow stages**
You can provide translations for workflow stage names so the names appear in the language selected for the instance.

The instance must already have language internationalization plugins installed. For more information, see **Activate a language**.

Language-specific text appears in workflow fields displayed in a list, workflow stage sets, and the Workflow Editor for users with that language selected. Language-specific text does not automatically appear when displaying stages on a form. To translate stages on a form, add translated text to the workflow field choices.
You can add translated text for any language enabled on the instance. For example, to translate workflow stages into French:

1. Set the interface language to French.
2. Navigate to Workflow > Workflow Editor.
3. Open and check out a workflow.
4. In the title bar, click the menu icon and select Edit Stages.
5. Edit the Name field for each stage and enter the text to display to French users.
   Do not change the Value field.
6. Confirm that the workflow stages display the French text.

Alternatively, to translate stages for multiple workflows at once, you can directly edit the Workflow Stages [wf_stage] table. For example, to translate workflow stages from multiple workflows into French:

1. Set the interface language to French.
2. In the application navigation filter, enter wf_stage.list.
3. Edit the Name field for each stage and enter the text to display to French users. Do not change the Value field.

Workflow stage sets

Stage sets are named groups of workflow stages commonly used together. Create a stage set and assign it as a default set to any number of tables. You can import the choice list values of a workflow field as stages for a workflow, and export a stage set to create a new one.

A single stage set usually represents a process, such as the stages required to display the progress of a service catalog request. You can also assign a stage set as the default set for workflows on specific tables.

In an active context, workflow stages provide summary-level feedback about the progress of a workflow. Stage icons display the status of each activity as it is being driven by a workflow. The system updates a Stage field, defined in the workflow properties, to indicate the progress of the workflow through the possible stage values.

Updates to workflow stage values

During an upgrade, the system makes changes to the Value field of records in the Workflow Stage [wf_stage] table.

- All entries are made lowercase.
- All spaces and special characters are replaced with underscores.

These changes support #unique_3181 and enable workflows to display translated text in the Stage field.

Create a new stage set

You can create a new stage set by creating a stage set record and adding stage set entries manually.

Create a stage set record only when you want additional stages that are not available on the table by default.

1. Navigate to Workflow > Stage Sets.
2. Click New.
3. Enter a Name that indicates the purpose of the stage set.
   For example, you can create a Requested Item stage set to hold the stages commonly used by inventory tracking workflows or service catalog fulfillment workflows.
4. Click Submit.
5. Open the new stage set record.
6. In the Stage Set Entries related list, click New.
   Each stage set entry can be used as the Stage for an activity in a workflow that uses this stage set.
7. Enter a Name that indicates the stage name to appear in workflow fields.
8. Enter a Value to use when referencing the entry, such as in a script.
9. Click Submit.
10. In the Stage Set Entries related list, ensure that each entry has a unique Order value.
    Enter a low value for stages that should appear early in the workflow and a higher value for later stages.

The stage set can be added to a workflow or assigned as the default stage set for workflows that are created for a specific table.

*Use a default stage set*
You can assign a stage set as a default set to any number of tables.

The stages in the assigned stage set pre-fill the workflow version stages when you create a new workflow for the associated table.

1. Navigate to Workflow > Default Stages (by table).
2. Click New.
3. Select a Table.
4. Select the Set you want to assign to the selected table.
5. Click Submit.

Import stages from a choice list
You can import the choice list values of a workflow field as stages for a workflow.

Create a choice list as follows:
• Add a custom field of Type Workflow to the table.
• Configure the custom field to use a choice list.
• If you are creating a new field, set the Choice List type to Display without --None-- and create the choices for the newly created field.

For more information, see Create a workflow stage field.
1. Navigate to Workflow > Workflow Editor.
2. Open and check out the workflow.
3. In the title bar, click the menu icon and select Properties
4. In the Workflow Properties dialog box, click the Stages tab.
5. From the Stage field list, verify that the correct workflow field is selected.
6. In the Related Links section, click Import Stages from Choice List.
7. In the dialog box asking you to confirm that you want to import the choice list, click OK.
8. Click Update.

The stage set can be added to a workflow or assigned as the default set for workflows that are created for a specific table.

Export a stage set from a workflow
You can create a new stage set by exporting the stages from an existing workflow as a set, instead of manually adding stage set entries to a stage set record.
1. Navigate to Workflow > Workflow Editor.
2. Open and check out the workflow containing stages that you want to export as a new stage set.
3. In the title bar, click the menu icon and select Edit Stages to open the Workflow Stages dialog box.
4. In the Related Links section, click Export to Stage Set.
5. Enter a unique Name for the new stage set.
6. Click OK.

The stage set can be added to a workflow or assigned as the default set for workflows that are created for a specific table.

Add a stage set to a workflow
You can add any number of stage sets to an existing workflow.

When multiple stage sets have stage set entries with the same Value, the stage appears on the workflow only once.
1. Navigate to Workflow > Workflow Editor.
2. Open and check out the workflow.
3. In the title bar, click the menu icon and select Edit Stages to open the Workflow Stages dialog box.
4. In the Related Links section, click Import from Stage Set.
5. Select the stage set.
6. Click Ok.
7. Import additional stage sets as needed for the workflow.
After you add all necessary stage sets to the workflow, you can add them to the workflow activities. For more information, see Add a stage to a workflow activity.

**Create a workflow stage field**

Workflows can provide a summary of workflow progress by updating any field of the Workflow type. If the field is a workflow field, it displays an icon to indicate the workflow stage progress.

Role required: admin

In a form, the workflow field displays the current stage as a choice list value.

In a list, the workflow field displays stage icons that represent the series of states, stages, phases, or tasks within a workflow. The stage icons are populated using the activity stages from the associated workflow. For more information, see Workflow stages.

To create a workflow stage field:

1. Navigate to Workflow > Default Stages (by table).
2. Right-click near a column header and select Configure > List Layout.
3. Create a new field in lower right.
4. On the form view of the table used by the workflow, create a field with the Type set to Workflow. For detailed steps, see #unique_3187.
5. Click Save.
6. Right-click the field label and select Configure Dictionary.
7. Open a dictionary entry.
8. In the Choice List Specification section of the Dictionary Entries form, select Dropdown with --None-- from the Choice list.
9. Click Update.
10. To ensure that the workflow field properly displays stages on the form, define a choice for each workflow stage.
    
    - To create workflow stages using a choice list that already has choices, you can import the stages from the choice list. A stage is created for each choice defined for the Stage field selected in the workflow properties. For detailed steps about importing a choice list, see Import stages from a choice list.
    - The Value of each choice must match the Value of the corresponding workflow stage.
    - Do not use spaces in the Value field for either choices or stages. Use underscores in place of spaces.
• Make the choice list read-only. If a user changes the stage value for a record from the choice list rather than allowing the workflow to control the value, the workflow-driven, legacy, and linear renders may not work as intended. You can also use business rules or events to ensure the workflow progresses accordingly.

For detailed steps on defining choice lists, see #unique_3188.

11. To see workflow stages as icons, add the field to the list layout of the workflow table.

For detailed steps, see #unique_2542.

After you create or update the workflow field:

• Unless the workflow uses the Requested Item [sc_req_item] table, ensure that the workflow field is selected from the Stage field list in the workflow properties. For detailed steps, see Select a stage field.

If a workflow uses the Requested Item table, the stage field is automatically set to the Stage field of the table and cannot be changed.

• Work through the workflow. Any other updates made to the workflow field, such as updates from business rules or other scripts, can interfere with displaying workflow stages.

Select a stage field

A Stage field allows the workflow context to show additional workflow information, such as the stage name and the estimated completion time for an activity.

Ensure that the workflow field you want to use as the stage field is configured to properly display stages. For detailed steps, see Create a workflow stage field.

Unless the workflow uses the Requested Item [sc_req_item] table, you can specify which field from the workflow table is the stage field. For workflows that use the Requested Item [sc_req_item] table, the stage field is automatically set to the Stage field of the table and cannot be changed.

To add or edit a workflow stage field:

1. Navigate to Workflow > Workflow Editor.
2. Create or check out the workflow.
3. In the title bar, click the menu icon and select Properties.
4. In the Workflow Properties dialog box, click the General tab.
5. In the Table list, verify that the table containing the workflow field is selected.
6. Click the Stages tab.
7. From the Stage field list, select the workflow field.
8. Click Update.

Display approvers in workflow stage fields

Enable workflow stage fields to display approvers, change the number of approvers to display, or disable displaying approvers.

Role required: admin

By default, only workflow stage fields that use the Workflow-driven renderer can display a list of approvers. Only these workflow stage renderer types support displaying approvers.

• Linear renderer
• Main flow renderer
• Workflow-driven renderer

1. Navigate to Workflow > Administration > Properties.

The system displays the Workflow Properties page.
2. Set the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.workflow.renderer.show_approver_limit</td>
<td>Sets the maximum number of approvers to display within a workflow stage field. The system displays an ellipsis character when there are more approvers than the display limit allows.</td>
</tr>
<tr>
<td>• Type: integer</td>
<td>• Default value: 5</td>
</tr>
<tr>
<td>glide.workflow.renderer.linear.show_approver</td>
<td>Enables (true) or disables (false) the Linear renderer to display approvers.</td>
</tr>
<tr>
<td>• Type: true</td>
<td>• Default value: false</td>
</tr>
<tr>
<td>glide.workflow.renderer.mainflow.show_approver</td>
<td>Enables (true) or disables (false) the Main flow renderer to display approvers.</td>
</tr>
<tr>
<td>• Type: true</td>
<td>• Default value: false</td>
</tr>
<tr>
<td>glide.workflow.renderer.workflowdriven.show_approver</td>
<td>Enables (true) or disables (false) the Workflow-driven renderer to display approvers.</td>
</tr>
<tr>
<td>• WorkflowType: true</td>
<td>• Default value: true</td>
</tr>
</tbody>
</table>

3. Click Save.

4. Add stages to workflows that have associated workflow stage fields.

   **Note:** If you add stages to a subflow, the parent workflow must also have stages.

5. For each approval activity you want to display approvers, select a Stage value.

   For example, the sample workflow **Service Catalog Item Request** has two approval activities. The first **Approval - User** activity has a Stage value of Dept. Head Approval. The second **Approval - User** activity has a Stage value of CIO Approval.

   The workflow stage field renderers you enabled display approvers up to the approver display limit. For example, a Workflow-driven stage field displays up to five approvers when the workflow reaches an approval stage.

   **Workflow stage field icons and tooltips**

   A workflow stage field displays icons to indicate the workflow stage. Based on the stage renderer selected for the workflow, these icons may display a tooltip with additional information.

   **Workflow field icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Workflow stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>![current active step]</td>
<td>Current active step</td>
</tr>
<tr>
<td>![approval pending]</td>
<td>Approval pending</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Stage tooltips

Based on the stage renderer selected for a workflow, workflow stage icons may display tooltips with detailed information about a stage.

### Stage renderers and tooltip behavior

<table>
<thead>
<tr>
<th>Renderer</th>
<th>Tooltip behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legacy</td>
<td>When a user points to a stage, the tooltip displays the name of the stage. In the expanded view, the activity status appears in parentheses next to the stage.</td>
</tr>
<tr>
<td>Renderer</td>
<td>Tooltip behavior</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Other renderers</td>
<td>When a user points to a stage, the tooltip displays the name of the stage. If the stage is a gated approval, the tooltip also shows the name of the approver. In the expanded view, the activity status appears in parentheses next to the stage.</td>
</tr>
</tbody>
</table>

If you do not want the approver’s name included in the tooltip, navigate to **System Properties > Service Catalog** and clear the **Show the current pending approver’s name in the stage widget mouseover** check box.

![Tooltip Example](image)

**Show the current pending approver’s name in the stage widget mouseover**

- Yes
- No

**Property for displaying pending approver’s name**

**Workflow stage renderers**

Workflow stage renderers determine how a workflow displays stages in a workflow field.

There are multiple renderers available.

**Note:** Most workflows should use the workflow-driven renderer. This renderer is used by default for all workflows. Use a different stage renderer only after careful consideration and to satisfy specific requirements for how the stages appear.
Workflow-driven

Use the workflow-driven renderer as much as possible. This renderer displays icons for stages using the stage state controlled by the workflow. Icons are displayed in a way that is meaningful for many situations. This renderer can display stages from a main workflow and subflows. The order of the icons is determined by the expected path of the executing workflow. As the workflow progresses, stages on paths that the workflow did not take are removed from the display. Stages from paths other than the expected path are not included unless the workflow follows that path.

The **Stage order** field on the **Stages** tab has two options:

- Computed uses the actual workflow path in order
- User-specified uses the order specified in the **Order** column on the Workflow Stages record

**Note:** If the workflow context for a request item has been deleted, the stages for that request item can no longer be rendered. This stage history is stored on the workflow context.

Main flow

The main flow renderer displays icons for stages defined in the main workflow only. Use this renderer when you do not want to expose the details of the subflows. For example, a single main workflow may run several subflows to handle implementation details. The stages in these subflows do not provide useful information for the user who starts the workflow, but are useful when editing the subflow. In this scenario, using the main flow renderer leads to the best user experience. The stage field displays the high-level process of the workflow without exposing unnecessary details.

The **Stage order** field on the **Stages** tab has two options:

- Computed uses the actual workflow path in order
- User-specified uses the order specified in the **Order** column on the Workflow Stages record

Linear

Linear rendering displays all stage icons from the main workflow and all subflows within a single workflow field on a list or form. It displays icons in a linear sequence regardless of the paths the workflow follows as it executes. This renderer uses stages defined in both the main workflow and any subflows that the main flow launches. The icons appear in the user-specified order. Skipped stages do not appear.

Use this renderer when the workflow stages must display in a consistent order and the actual details of how the workflow runs are less important. For example, a workflow may revisit or revert to previous stages based on one or more **Condition Workflow** activities. Displaying these loops in the stage field does not provide useful information to the user. In this scenario, using the linear renderer leads to the best user experience. The stage field displays the predefined process, including stages from subflows, in a consistent order.

For example, you can create a service catalog workflow that uses a subflow to complete delivery of the requested item. The following images illustrate the main flow and subflow for ordering corporate-branded supplies.
Linear main flow

Linear subflow

The linear renderer displays all these stages in one workflow field. The parent workflow specifies the Waiting for approval, Fulfillment, and Completed stages. The subflow specifies the Delivery and Waiting for Task, and Delivery OK stages.

Progress bar

The progress bar renderer displays a single progress bar instead of a sequence of stage icons. This renderer is particularly useful when you want to display the general progress of the workflow as a percent. Each stage in the workflow controls an equal percentage of the progress bar. For example, if a workflow has 10 stages, reaching each stage causes the workflow field to display an additional 10% of the progress bar. Stage names do not appear in the progress bar.
The progress bar renderer provides a way to display the status of a workflow that has a large number of stages. Other rendering options may provide a better user experience when rendering fewer than four stages in a single workflow.

The Stage order field on the Stages tab has two options:

- Computed uses the actual workflow path in order
- User-specified uses the order specified in the Order column on the Workflow Stages record

Legacy

The legacy renderer displays stages in the same way as releases prior to Dublin. When an instance is upgraded from a release prior to Dublin, all existing workflows are set to use the legacy renderer. Whenever possible, use a different stage renderer instead. If you want your workflow to maintain pre-Dublin behavior, use the Legacy option. The legacy renderer sometimes assigns incorrect data to and/or reports incorrect data from the workflow stage field. If possible, we recommend all workflows use the Workflow-driven renderer.

With the legacy renderer, you can create and reference a custom workflow field icon set by setting the icons attribute to a new script include. For example, to use the WorkflowIconsSCR script include to define which icons to use, add the attribute icons=WorkflowIconsSCR to the Attributes field of the dictionary entry for the workflow field. To use the default icon display behavior, use the attribute icons=WorkflowIconsStages.

The legacy renderer works with all tables except the Requested item [sc_req_item] table. In this case, use the requested item renderer instead.

Requested item

The requested item renderer functions the same way as the legacy renderer, but is for use with the Requested item [sc_req_item] table.

Only in Now Mobile, default stage renderer is used.

Select a stage renderer

In most cases, the default workflow-driven renderer should be used. If you have specific requirements for displaying stages, you can select a different stage renderer.

Consider the following when selecting a stage renderer:

- Use the workflow-driven renderer if possible. This is the default renderer that should be used in most cases.
- Use the legacy renderer only if your instance was upgraded from a release prior to Dublin and you want your workflow to maintain pre-Dublin behavior.

To use linear, main flow, or progress bar rendering, satisfy the following requirements.
Linear and progress bar renderer requirements

<table>
<thead>
<tr>
<th>Renderer</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| Linear         | • The parent workflow and all subflows must modify the same current record.  
• In the properties for all subflows, the **Stage field** value for all subflows must match that of the parent workflow.  
• The parent flow and all subflows must contain the same stages. Use a stage set to ensure the parent flow and all subflows have the same stages.  
• On the workflow canvas, each workflow needs only the stages used directly by that workflow. It is not necessary to add stages from subflows to activities on the parent flow, or stages from the parent flow to activities on the subflows. |
| Main flow      | • The workflow contains subflows.  
• You do not want or need to reveal the details about the subflows.                                                                                                                                 |
| Progress bar   | • The workflow properties must have a **Stage ordering** value of **User-defined**  
• There must be workflow stages within the workflow.  
• Because stage names do not appear in a workflow field when using the progress bar renderer, you can simplify stage names to represent a percentage of the workflow. For example, if a process has four main steps, name the workflow stages as 25%, 50%, 75%, and 100%. Enter the numerical value of each stage, such as 25, in the **Value** and **Order** fields. |

To select a stage renderer:

1. Navigate to **Workflow > Workflow Editor**.
2. Open and check out the workflow.
3. In the title bar, click the menu icon and select **Properties**.
4. In the Workflow Properties dialog box, click the **Stages** tab.
5. From the **Stage rendering** list, select a stage renderer.
   - If you are using two workflows to update two unique workflow fields on a single record, both workflows must use a non-legacy renderer. You can select a different stage renderer for each workflow but do not select **Legacy** for either one.
   - If you want to use the linear renderer, make sure you select **Linear** in the properties for the parent workflow and all subflows.
6. Click **Update**.
Workflow fields with deleted records

Workflow fields may indicate when a record required by the workflow is deleted.

After a referenced record is deleted, the reference in the primary record is no longer valid. If the stage renderer detects a reference that is no longer valid, the stage field displays a message about the deleted record.

Administrators can restore deleted records. For more information, see #unique_3196.

![Example of workflow with deleted record](image)

Workflows with missing records

The image shows a list with two workflows. The top request does not have an associated request item. The bottom request has an associated request item, but the item does not have an associated workflow context.

Workflow validation

Workflow validation examines different characteristics of a workflow to locate issues that might prevent the workflow from being published or cause it to fail. The validation report summarizes the results of each separate workflow validation.

Validation prevents workflows with critical flaws from executing and resulting in an unstable or incomplete state. There are a number of validators in the base system that notify workflow designers of potential problems. For example, multiple End activities, disconnected transitions, incorrect table references, missing subflows, and dependencies affected by update sets. A workflow validation report displays the results from each validator, including a message explaining what was found. The system automatically validates a workflow when you publish it. You can also run validation on a workflow directly from controls in the Workflow Editor.

Highlighting critical errors

The graphical Workflow Editor highlights critical errors when a workflow is loaded. In this example, a subflow is missing and is not available to the parent workflow for the current user. The graphical Workflow Editor indicates the error when the parent workflow loads by highlighting (in red) the activity that calls the subflow. To correct the error in the parent workflow, click the validate icon in the header bar and inspect the error description in the validation report.
Validations at publishing

If you attempt to publish an invalid workflow or a workflow with potential problems, the system displays an error message and blocks the operation, if necessary. When validation error messages appear, click the validate icon in the graphical Workflow Editor to see the error report.

Validation warning

A validation warning notifies you that a potential problem exists in a workflow but permits you to publish the workflow. Validation warnings appear when:

- You edit and then attempt to publish a workflow that is included as a subflow in another workflow. The system cannot determine how your changes will affect the parent workflow and alerts you of the relationship.
- A workflow activity uses a different table than the table assigned to the workflow. The system alerts you of the potential conflict.

Validation failure
A validation failure notifies you that a critical error has occurred in the workflow that prevents you from publishing the workflow. An example of a critical error is a missing subflow.

Workflow validation report

Validators display three notification levels: CRITICAL, WARN, and INFO. The designer can publish a workflow that returns WARN or INFO level validation, but not a workflow that returns an overall validation level of CRITICAL.
Workflow validation report

Header summary

The header of the validation report summarizes the entire validation run against the specified workflow.

- **Validate Summary**: The overall score reflects the most severe notification level encountered during the validation.
- **Total checks performed**: The total number of validations run is also broken down to show the number at each notification level.

Report columns

The body of the report displays the results of each individual validation check that was performed. The columns are **Type**, **Level**, and **Message**. You can sort and filter these columns as you would any list.
Workflow termination and external dependencies levels

<table>
<thead>
<tr>
<th>Name</th>
<th>Implication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info</td>
<td>Provides information about the current workflow version. An example of an information level message is one that names the lowest common table in the workflow. Workflows at this validation level are considered valid and publishable.</td>
</tr>
<tr>
<td>Warning</td>
<td>Alerts the user that the validator detected anomalies in the workflow that might compromise its ability to execute. An example of a warning level message is one that alerts you to a missing activity input transition. Workflows at this validation level are considered valid and publishable.</td>
</tr>
<tr>
<td>Critical</td>
<td>Names a workflow element containing a critical error that prevents the workflow from executing successfully. Examples of this are missing or invalid subflows and missing transitions. Workflows at this validation level cannot be published or run in production.</td>
</tr>
</tbody>
</table>

**Message**

The validation message provides a detailed description of the results, including table names, update sets, and other specifics.

For the procedure to validate a workflow and generate a validation report, see [Validate a workflow](#).

**Workflow validator**

ServiceNow offers several workflow validators for workflow designers to test their workflows.

This page lists all available workflow validators. See [Workflow validation](#) for information on using workflow validators and the workflow validation report to see the type of information that is returned.

**Hanging workflows and update sets**

<table>
<thead>
<tr>
<th>Hanging Workflows</th>
<th>Update Sets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identify workflow design decisions that can result in a hanging workflow</td>
<td>Identify related artifacts being moved in different update sets</td>
</tr>
<tr>
<td>ValidateTransitionOut</td>
<td>ValidateUpdateSetDependencies</td>
</tr>
<tr>
<td>ValidateTransitionIn</td>
<td>ValidateUpdateSetParentDependencies</td>
</tr>
<tr>
<td>ValidateDanglingTransition</td>
<td>ValidateInputVarUpdateSetDependencies</td>
</tr>
<tr>
<td>ValidateSubflows</td>
<td></td>
</tr>
<tr>
<td>ValidateScriptForCurrentDotUpdate</td>
<td></td>
</tr>
</tbody>
</table>

**Workflow termination and external dependencies**

<table>
<thead>
<tr>
<th>Unexpected Workflow Termination</th>
<th>External Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identify workflows that can end unexpectedly</td>
<td>Identify external artifacts that have potential workflow dependencies</td>
</tr>
</tbody>
</table>
### Unexpected Workflow Termination

The **ValidateTransitionOut** validator finds activity conditions with no exit transitions.

### Validation summary

- **Risk:** Activity conditions might not transition to the next activity, which could cause the workflow to hang.
- **Severity Level:** Warning
- **Valid Result:** Valid
- **Valid Message:** All conditions have transitions.
- **Invalid Result:** Invalid
- **Invalid Message:** This workflow contains `<condition count>` activity conditions without an output transition.
- **Suggested Action:** If this is a conscious design decision, there is no corrective action. Otherwise, find the condition cited in the validator and add an appropriate transition to the next activity.
- **Publishable:** Yes
- **Runnable:** Yes
- **Related Information:** None

### Troubleshooting

Design choices made when creating a workflow on the canvas might legitimately use an activity without an exit condition. In the first example, the **Notification** and **Timer** activities both execute at the start of the workflow. The **Timer** is the entity that decides when the workflow ends. In this situation, executing the **Notification**, but not transitioning away, keeps the design simple and adds no risk. The validator finds and reports the missing transition from the **Notification** activity as a **Warning** that the designer can ignore.
In the second example, the **Notification** activity has no exit transition. The designer missed this because of the layout. The transition from the **Timer** activity passes behind the **Notification** activity and appears to connect the exit from the **Notification** activity to the **End**. In workflows with more than 10 or 15 activities, it might be difficult to see all the transitions clearly. This workflow's designer intended for the **Notification** activity to transition to the **End**.

This validator directs the designer to the specific activity and condition that does not have an exit transition. The designer then makes the decision whether or not to respond to the warning.

**ValidateTransitionIn**

The **ValidateTransitionIn** validator finds activities that do not have inbound transitions and cannot execute in the workflow.

**Validation summary**

- **Risk**: Activities that do not have inbound transitions have no means of being executed in the workflow. If other logic builds from these activities, the workflow could hang, with no means of moving forward.
- **Purpose**: Find activities that do not have inbound transitions.
- **Severity Level**: Warning.
• **Valid Result**: Valid.
• **Valid Message**: All activities in this workflow have at least one inbound transition.
• **Invalid Result**: Invalid.
• **Invalid Message**: This workflow contains <activity count> activity conditions without an input transition.
• **Suggested Action**: Either remove the activities to reduce confusion and make the workflow easier to understand or provide the appropriate inbound transition.
• **Publishable**: Yes
• **Runnable**: Yes
• **Related Information**: None

**Troubleshooting**

Although the activities detected in this validator do no harm to the execution of the workflow, the designer needs to know that there are activities on the canvas that cannot execute and serve no purpose, particularly in a production system. This error is typically caused by a visual misinterpretation of the drawing.

This example workflow appears to be perfectly valid. Under closer inspection, however, we see that the transition from *Set Values* does not stop at *Approval - User* (there is no arrow end). Instead, that transition goes directly to *End*. As a result, *Approval - User* cannot execute. Because there is an activity in the workflow based on the approval's condition routing, it appears that the designer intended for the approval to execute and that a correction is needed.

This validator directs the designer to the specific activity and condition that has no inbound transition. The designer should establish a transition or remove the activity.

*ValidateDanglingTransition*

The *ValidateDanglingTransition* validator finds and reports any transitions that do not terminate on an activity.
Validation summary

- **Risk:** A workflow with dangling transitions will silently hang a workflow with no recovery options.
- **Severity Level:** Critical
- **Valid Result:** Valid
- **Valid Message:** Valid
- **Invalid Result:** Invalid
- **Invalid Message:** Invalid
- **Suggested Action:** Remove or connect the offending transition. Get the source activity name from the validation report details and resolve the issue. Then, run the validation again to test your changes.
- **Publishable:** No
- **Runnable:** No
- **Related Information:** None

Troubleshooting

On rare occasions, the destination of a workflow transition becomes null. The workflow canvas shows no evidence of the transition, but at run time, the workflow hangs when it encounters one of these dangling transitions. If the `ValidateDanglingTransition` validator reports this condition at publishing time, it blocks the publication action until the issue is resolved. If this condition is detected on a runtime check, the workflow is not allowed to execute against a current record's transaction. Instead, the system adds a critical log entry detailing the activity with the faulted transition to the current record's workflow context. To enable the workflow to execute on the next appropriate transaction, remove the faulted transition from the workflow model.

To find and remove the faulted transition:

1. Make note of the workflow version and activity that contains the faulted transition as indicated in the validator details.
2. Navigate to **Workflow > Administration > Workflow Version**.
3. In the list of workflow versions, select the workflow that has the faulted transition.
4. On Workflow Version form, add the workflow activities related list. Click the menu icon, select **Configure > Related Lists**, move **Workflow Activity-->Workflow Version** from the **Available** list to the **Selected** list, and click **Save**.
5. In the **Workflow Activities** related list, select the activity cited in the validator.
6. In the Workflow Activity form, view the **Workflow Transitions** section or tab and identify the transition in that list that has no value or a null value in the **To** column.
7. Delete this transition.
8. Return to the workflow version and re-run the validation check.

The Critical warning should disappear. The workflow should execute as expected on the next appropriate transaction.
**ValidateSubflows**

The **ValidateSubflows** validator detects any workflows included as subflows that are either inactive, deleted, or not available as a published workflow for the current user.

Any of these conditions cause the workflow to hang when the workflow activity in the main flow is encountered.

⚠️ **Warning:** This is a critical error that prevents a workflow from running.

**Validation summary**

- **Risk:** A parent workflow that transitions to a deleted subflow hangs indefinitely, with no recovery options.
- **Severity Level:** Critical
- **Valid Result:** Valid
- **Valid Message:** This workflow contains `<count>` valid subflows.
- **Invalid Result:** Invalid
- **Invalid Message:** This workflow contains `<invalid count>` invalid subflow(s) of `<total subflow count>` total subflows.
- **Suggested Action:** Remove the link in the parent workflow to the questionable subflow, examine the subflow to ensure that it is valid and published, or that it is checked out to the current user. After making the correction to the state of the subflow, run the validation again to test your changes.

- **Publishable:** No
- **Runnable:** No
- **Related Information:** Workflows used as subflows

**Troubleshooting**

When a workflow runs, regardless of whether it is a subflow or a main flow, the script engine determines which version of a workflow should execute, given the current user and workflow conditions. When a workflow is checked out by the same user who is running the workflow, the checked out version is the version that executes. If the user is not the same person who has the workflow checked out, the published version of the workflow executes. If there is no published workflow, no workflow runs.

One scenario addressed by the **ValidateSubflows** validator is when a workflow:

- Is checked out to User A.
- Is a subflow in a parent workflow being run by User B.
- Has no published alternative to the subflow being run by User B.

When this occurs, the parent workflow runs to the execution of the unpublished subflow and then hangs at that activity, with no means to transition forward. Main flows that encounter this condition in a subflow are not permitted to execute against a current record's transaction. Instead, a critical log entry detailing the subflow's state is added to the current workflow's Workflow Context record. To correct the problem, remove the subflow from the main flow, or publish the subflow so it is available to User B. This allows the workflow to execute on the next appropriate transaction.

Another scenario addressed by the **ValidateSubflow** validator is when a workflow:

- Is a subflow in a parent workflow being run by any user.
- Has no published alternative to the subflow, because the workflow has been deleted or all versions of the workflow are unpublished or inactive.
Note: You cannot delete a from a list or form workflow that is a subflow. However, you can create one of these unstable conditions with advanced scripting, SQL options, or incomplete update sets that contain main flows, but not the referenced subflows. When troubleshooting a workflow that triggered this validator, consider the history of the subflow while assessing the error condition.

ValidateScriptForCurrentDotUpdate

The ValidateScriptForCurrentDotUpdate validator finds workflow activities with scripts that use the current.update() function.

Calling current.update() causes significant performance delays in transaction processing and might cause an instance to hang.

Validation summary

• Risk: At best, a workflow that uses current.update() in scripts experiences degraded performance. In the worst case, the workflow enters an infinite, recursive loop that crashes the server.
• Severity Level: Warning
• Valid Result: Valid
• Valid Message: The JavaScript in this workflow has no instances of 'current.update()'.
• Invalid Result: Invalid
• Invalid Message: This workflow uses 'current.update()' in <count of current.update references> JavaScript statements.
• Suggested Action: Remove current.update() from the activity scripts cited by this validator.

Problems with current.update() in workflow scripts

A workflow initiates execution in one of these ways:

• Script Engine: If a workflow is assigned to a specific table, and given a run condition, the workflow runs on INSERT.
• Script: Any business rule, script include, background script, or client script can initiate a workflow using the workflow script include and calling startFlow().

The workflow engine initiates a workflow based on the matched criteria of the current record being inserted. The transaction for current is managed by the script engine and not the workflow. Workflows that progress on the update() of the current record are not invoked via the workflow engine, but as a call from either a client script or business rule. In either case, the script engine is invoked, and the current record is put in memory. Edits and modifications to any current fields are made and are available to other activities and scripts that are executed in the same transaction.

When appropriate, other engines that run in sequence with the workflow engine, such as the business rule engine or field normalization, are invoked against the same current record transaction. Any changes made to current through these scripts and activities modify the record in memory. These changing values are available for reference in any other transactions called from activities and scripts in the same INSERT transaction. When all expected changes are executed, the current record is inserted.

When one of these scripts calls current.update() on a record that has yet to be inserted, the action forces an unnecessary and error-prone database transaction. If a record is not yet in the database, it
cannot be updated. Business rules that trigger on `update()` on a record that is in the process of being inserted can cause a very unstable and potentially infinite looping condition.

**Troubleshooting**

This validator detects the use of `current.update()` in any of the editable script fields. Do not call `current.update()` from within a workflow script. In the event of an INSERT or UPDATE of `current`, the changes made to `current` are available to all scripts executing in the same transaction, and the script engine stores all changes in the database. Leave the update of `current` to the engine. Use the scripts only for setting and referencing the current field values.

**ValidateLowestCommonTable**

The `ValidateLowestCommonTable` validator reports the lowest table in the Glide hierarchy that the workflow uses.

For example, the Requested Item [sc_req_item] table is the lowest table in a workflow containing a Catalog Task activity. This information is significant to a designer who wants to change the table against which an existing workflow runs after adding activities to the canvas.

**Note:** This validator provides information only. It does not indicate an error or warning condition.

**Validation summary**

- **Risk:** This validator informs only and has no risk associated with it.
- **Severity Level:** Data/Information
- **Valid Result:** Valid
- **Valid Message:** The lowest common table in this workflow is `<table_name>`.
- **Invalid Result:** N/A (informational only)
- **Invalid Message:** N/A (informational only)
- **Suggested Action:** None
- **Publishable:** Yes
- **Runnable:** Yes
- **Related Information:** Workflow activities

**ValidateTableChange**

The `ValidateTableChange` validator reports any activities in the workflow that are invalid given the table associated with the workflow version.

For example, a workflow version that is associated with the Change Request [change_request] table but has a Catalog Request activity on the canvas is invalid, since the activity is not compatible with the selected table.

**Validation summary**

- **Risk:** If the current record at runtime does not originate from the table specified by the lowest common table, the activities for the lowest common table cannot set specific values.
- **Severity Level:** Warning if the table that is associated with a workflow is higher in the table hierarchy than the lowest common table required for the workflow activities.
- **Valid Result:** Valid
- **Valid Message:** All activities are valid for the newly selected table
- **Invalid Result:** Invalid Activity
• **Invalid Message:** This workflow contains <count of invalid activities> invalid activities for the newly selected table.

• **Suggested Action:** Make one of these changes:
  • Change the workflow to not require the activities associated with the lowest table reported.
  • Modify the workflow to use a table that contains the lowest common table in its hierarchy.
  • Ensure that the current record meets the requirements of the at-risk activities.

• **Publishable:** Yes
• **Runnable:** Yes

• **Related Information:** Workflow activities

**Troubleshooting**

Navigate to **Workflow > Administration > Activity Definitions.** Note the **Table** column in the list. Each activity that is not global is associated with a table.

When you select a table in the Workflow Properties form, the activity menu presents only activities that are compatible with the selected table. Associating a table with a workflow activity enables the system to make certain decisions about the activity that affect value comparison, condition routing, or the setting and getting of field values in the current record.

When a workflow is set to the Global [global] table, it is possible that the process executing the workflow ensures that the current record meets the requirements of the activities identified by this validator. In that case, the activity still works as expected. If that assurance cannot be guaranteed by the user process, do not use the activity identified by the validator without assigning a table that meets the requirements of all the activities on the canvas.

This validation check ensures that the table specified by all the activities in a particular workflow is included in the hierarchy of the table selected for the workflow.

*ValidateParentFlow*

The **ValidateParentFlow** validator reports any workflows that use the workflow as a subflow.

**Validation summary**

• **Risk:** There is no risk in a workflow being a subflow. This is only a warning that other workflows are at risk from dramatic changes to a subflow.
• **Severity Level:** Warning
• **Valid Result:** Valid
• **Valid Message:** Currently <workflow version name> is not a subflow.
• **Invalid Result:** None
• **Warning Message:** This workflow version (<workflow version name>) is required as a subflow in <workflow version count> other workflows.
• **Suggested Action:** Exercise caution when modifying things like input parameters and return values to assure that parent workflows are not adversely affected.

• **Publishable:** Yes
• **Runnable:** Yes

• **Related Information:** Workflows used as subflows
Troubleshooting

The system warns the workflow designer at publishing time and during validation that a workflow is a subflow. This warning reminds the designer that changes to the current workflow have the potential to affect workflows cited in the validation report or other workflows already running in production. Regardless of how simple the change to a workflow that is a subflow, thoroughly test all parent flows cited in this validation report before publication.

When a workflow is a subflow, changes that can cause it to become invalid include:

• Changing the data types of input variables. Verify that all parent workflows cited in this validation report can pass the correct value type.
• Adding input variables. Verify that all parent workflows cited in this validation report are able to pass all variable values into the subflow.
• Changing or removing the return value of a workflow. Verify that any changes to the return value of a workflow are compatible with the requirements of all the parent flows.
• Changing the table on which the workflow runs. Verify that the table selection is compatible with all parent flows.

Note: To delete a workflow that is a subflow, first remove the dependency by removing the subflow from all parent flows cited in this validation report. After the dependencies are cleared, a user with the proper role can delete the subflow.

ValidateSingleEnd

The ValidateSingleEnd validator finds and identifies multiple End activities in a single workflow.

Multiple End activities in a workflow might be intentional and have no affect on the workflow, or might be a mistake that the designer needs to correct.

Validation summary

• Risk: If the execution paths to the End activities are not mutually exclusive, then the first End encountered completes the workflow and cancels all other executing activities.
• Severity Level: Warning
• Valid Result: Valid
• Valid Message: This workflow contains 1 End activity.
• Invalid Result: Invalid Activity
• Invalid Message: This workflow contains <count of ends> End activities.
• Suggested Action: Remove extraneous End activities that are not intended as part of the design.
• Publishable: Yes
• Runnable: Yes
• Related Information: None

Troubleshooting

As soon as an End activity is encountered in the workflow, the workflow completes even if there are other viable execution paths leading to a second End activity that is still executing. Those executing activities are canceled as part of the End activity’s clean up actions. Therefore, the results of designing workflows with multiple Ends must be carefully considered.

In the case of large workflows, it is often more intuitive to read the workflow when there are multiple End activities. In the following example, the paths to the two Ends are mutually exclusive execution paths.
If this was a large workflow, with many activities between Branch and the second End, the value of the multiple ends becomes apparent. Tracing a No response from User is invalid to a single End behind 33 other activities would be significantly more difficult. There is no risk in this workflow design because there is no reason for other activities to execute if the End after the Notification activity terminates the workflow.

Mutually exclusive execution paths

The next example has multiple End activities in execution paths that are not mutually exclusive. A Yes response from User is valid causes the Set Values activity to finish immediately. By reaching its End activity first, this execution path cancels the Approval for Apps and the DB Task activities, which might not be the desired outcome. If the paths are all expected to complete before End, the activities should come to a Join (as in the previous example) that transitions to a single End.
Mutually Inexclusive Execution Paths

**Note:** To add the second End activity, right-click to copy the original End activity and paste it onto the canvas. In most cases, a single End is the best and most reliable way to ensure that all activities expected to execute prior to workflow completion, do so successfully.

**ValidateUpdateSetDependencies**

The ValidateUpdateSetDependencies validator identifies all the subflows called in the current workflow and determines if any of those subflows are being edited in a different (in progress) update set.

This warning informs the user that this workflow and one or more of its dependencies are being actively modified in a way that will not deploy concurrently to another instance without additional effort.

For information about update sets, see Create and select an update set.

**Validation summary**

- **Risk:** If a parent workflow is edited in one update set and its dependent subflow is edited in another, the two workflows might not be compatible when moved to a different instance. Making independent changes, such as to common or expected values, can make the two workflows incompatible.
- **Severity Level:** Warning
- **Valid Result:** Valid
- **Valid Message:** There were no Update Set dependency issues found.
- **Invalid Result:** Invalid

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• **Invalid Message:** This workflow has dependent workflows that are in a different update set.
• **Suggested Action:** Modify and deploy both workflows in the same update set. If you must modify dependencies in separate update sets, use one of these methods:
  - Ensure that all update sets migrate concurrently.
  - Prior to deploying the main flow update set, merge the dependencies into one update set before completing that update set.

• **Publishable:** Yes
• **Runnable:** Yes
• **Related Information:** Workflow movement with update sets

**Troubleshooting**

A workflow is added to an update set only when the workflow is published. This validator issues a warning when either of the following conditions exist:

• A published subflow is in a different update set than the parent workflow and that update set is In progress.
• A subflow is checked out by another user, who is working in a different update set than the current user.

**Note:** This validator does not look for update sets that have been closed. It looks only at update sets that are In progress or at the update sets of all subflows being used by the current workflow that are checked out to users who are working in a different update set.

**Example**

Following is an example of an at-risk development scenario in which two users create dependencies between workflows in different update sets.

**User A:**

1. Sets Update Set A to the current update set.
2. Checks out Workflow A.
3. Changes the return value of the String type in Workflow A to a Reference/User type.
4. Publishes Workflow A, causing an entry into Update Set A.

**User B:**

1. Sets Update Set B to the current update set.
2. Checks out Workflow B.
3. Includes Workflow A as a subflow.
4. Uses the user reference return value from Workflow A as an approval assignment.
5. Publishes Workflow B, causing an entry into Update Set B.
Risks

- User B moves Update Set B to a different instance that has an older version of Workflow A. The return value is not a user reference, which causes the outcome of Workflow B to be different than it was when tested in development.
- User B moves Update Set B to a new instance that does not have a version of Workflow A. Workflow B experiences a validation failure at runtime and cannot execute. A log entry is added to the workflow log of the current record.

Possible solutions

Solution 1
Migrate the parent workflow and all dependent workflows to a new instance together using the same update set.

1. Set the update set to the one you want to migrate to new instances.
2. Check out and republish the workflows that need to be included.
   • This action forces an entry into the current update set.
3. Complete the update set with all dependencies.
4. Follow standard procedures for migrating update sets to local instances.

Solution 2
Move dependent workflows between update sets.

1. Identify the update set containing the main workflow to be migrated.
2. Navigate to System Update Sets > Local Update Sets.
3. Find and select the update set that contains the dependencies to the main workflow.
4. In the Customer Updates related list, select the workflow version of the subflow you want to move.
5. Select the update set containing the parent workflow in the Update set field.
   • If this field is not on the Customer Update form, configure the form and add the field.
6. Click Update.
   • The base system moves the dependent subflow to the update set selected.
7. Repeat steps 4-6 to add additional dependent subflows to the parent flow update set.

ValidateUpdateSetParentDependencies
The ValidateUpdateSetParentDependencies validator identifies all the workflows that call the current workflow as a subflow and determines if any of those parent workflows are being edited in a different update set that is in progress.

This warning informs the user that this workflow and one or more workflows that depend on this workflow are being actively modified in a way that will not deploy concurrently to another instance without additional effort.
Validation summary

- **Risk:** If a parent workflow is edited in one update set and its dependent subflow is edited in another, the two workflows might not be compatible when moved to a different instance. Making independent changes, such as editing common or expected values, can make the two workflows incompatible.
- **Severity Level:** Warning
- **Valid Result:** Valid
- **Valid Message:** There were no Update Set dependency issues found.
- **Invalid Result:** Invalid
- **Invalid Message:** This workflow has dependent workflows that are in a different update set.
- **Suggested Action:** Modify and deploy both workflows in the same update set. If you must modify dependencies in separate update sets, use one of these methods:
  - Ensure that all update sets migrate concurrently.
  - Prior to deploying the main flow update set, merge the dependencies into one update set before setting that update set to complete.
- **Publishable:** Yes
- **Runnable:** Yes
- **Related Information:** Workflow movement with update sets

Troubleshooting

A workflow is added to an update set only when the workflow is published. This validator issues a warning when either of the following conditions exist:

- A published subflow is in a different update set than the parent workflow and that update set is In progress.
- A subflow is checked out by another user, who is working in a different update set than the current user.

**Note:** This validator does not look for update sets that have been closed. It looks only at update sets that are In progress or at the update sets of all parent workflows that call the current workflow and are checked out to users who are working in a different update set.

Example

Following is an example of an at-risk development scenario in which two users create dependencies between workflows in different update sets.

**User A:**
1. Sets Update Set A to the current update set.
2. Checks out Workflow A.
3. Changes the return value of the **String** type in Workflow A to a **Reference/User** type.
4. Publishes Workflow A, causing an entry into Update Set A.

**User B:**
1. Sets Update Set B to the current update set.
2. Checks out Workflow B.
3. Includes Workflow A as a subflow.
4. Uses the user reference return value from Workflow A as an approval assignment.
5. Publishes Workflow B, causing an entry into Update Set B.

Risks

- User B moves Update Set B to a different instance that has an older version of Workflow A. The return value is not a user reference, which causes the outcome of Workflow B to be different than it was when tested in development.
- User B moves Update Set B to a new instance that does not have a version of Workflow A. Workflow B experiences a validation failure at runtime and cannot execute. A log entry is added to the workflow log of the current record.

Possible solutions

Solution 1
Migrate the parent workflow and all dependent workflows to a new instance together using the same update set.

1. Set the update set to the one you want to migrate to new instances.
2. Check out and republish the workflows that need to be included.
   - This action forces an entry into the current update set.
3. Complete the update set with all dependencies.
4. Follow standard procedures for migrating update sets to local instances. For information about update sets, see System update sets.

Solution 2
Move dependent workflows between update sets.

1. Identify the update set containing the main workflow to be migrated.
2. Navigate to System Update Sets > Local Update Sets.
3. Find and select the update set that contains the dependencies to the main workflow.
4. In the Customer Updates related list, select the workflow version of the subflow you want to move.
5. Select the update set containing the parent workflow in the Update set field.
   - If this field is not on the Customer Update form, configure the form and add the field.
6. Click Update.
   - The base system moves the dependent subflow to the update set selected.
7. Repeat steps 4-6 to add additional dependent subflows to the parent flow update set.

ValidateInputVarUpdateSetDependencies
The ValidateInputVarUpdateSetDependencies validator examines update sets to ensure that workflow input variables for a given workflow have not been deleted in different update sets than those currently In progress.
Validation summary

- **Risk:** Workflows and their input variables are not moved together in a single update set. The deletion of input variables is captured in a different update entry. If these two entries are not in the same update set, the workflow execution can be unstable.
- **Purpose:** Determine whether input variables that belonged to this workflow were deleted in a different update set.
- **Severity Level:** Warning
- **Valid Result:** Valid
- **Valid Message:** There were no Input Variable Update Set dependency issues found.
- **Invalid Result:** Invalid
- **Invalid Message:** There are input variables that have been deleted and logged in a different update set.
- **Suggested Action:** If the deletion is not intended to be separate from the workflow, ensure that both update sets are committed concurrently to the new instance, or merge both payloads into a single update set.
- **Publishable:** Yes
- **Runnable:** Yes
- **Related Information:** Workflow movement with update sets

Troubleshooting

Workflow input variables get individual entries in the Customer Update related list in the current user’s update set. This validator reports to the user when workflow input deletions have happened in an update set other than the current user’s update set.

Follow the instructions for Input variable removal when the validator issues this warning.

*ValidateWorkflowEndStages*

The `ValidateWorkflowEndStages` validator checks that in workflows with stages, the end activity of the workflow has a stage named Complete or Completed.

If the workflow has stages associated with it, but does not have the completed stage on the end activity, then the stage indicator will not show that the workflow completed.

Validation summary

- **Risk:** The stage indicator will not show the workflow is completed.
- **Severity Level:** Warning
- **Valid Result:** Valid
- **Valid Message:** Workflow end stages are valid.
- **Invalid Result:** invalid
- **Invalid Message:** End activity A found with invalid stage “S.”
- **Suggested Action:** If this is not by design, make the appropriate changes.
- **Publishable:** Yes
- **Runnable:** Yes
- **Related Information:** Workflow activities
Troubleshooting

Check the workflow for an end activity. Ensure that this activity assigns a stage named Complete or Completed.

`ValidateWorkflowStageColumn`

The `ValidateWorkflowStageColumn` validator detects and reports when the stage field (stage column) for a workflow is not correct or is unusable.

Validation summary

- **Risk:** The stage indicators may not display appropriate information.
- **Severity Level:** Warning
- **Valid Result:** Valid
- **Valid Message:** Workflow stage values are valid.
- **Invalid Result:** Warning
- **Info Summary:** Stage warnings found.
- **Invalid Messages:**
  - Table T does not have a column named C.
  - Workflow for table T has stages, but no stage column.
  - Table T has a stage column "C," but no stages are set by activities.
  - Workflow on table T has stage column "C" that is not type=workflow.
- **Suggested Action:** If this is not by design, make the appropriate changes.
- **Publishable:** Yes
- **Runnable:** Yes
- **Related Information:** Workflow activities, Workflow stages

Troubleshooting

To check the stage column:

1. Open and check out a workflow.
2. Open the workflow version properties dialog by clicking the menu icon and selecting **Properties**.
3. View the **Stages** tab or section.
4. Check that the assigned stage column is actually a column in the table to which the workflow is associated.
5. Check that the column is type=workflow.

Tip: Stage columns should not be choice lists. If they are, the list appears read-only in form views, since changing that column value outside the workflow engine does not ensure safe tracking of stage states.

`ValidateWorkflowStateValues`

The `ValidateWorkflowStateValues` validator checks a number of stage aspects in workflow activities for correctness.

This validator has multiple possible error messages.
Validation summary

- **Risk:** The stage indicators may not display appropriate information.
- **Severity Level:** Warning
- **Valid Result:** Valid
- **Valid Message:** Workflow stage values are valid.
- **Invalid Result:** invalid
- **Warning summary:** Stage warnings found.
- **Invalid Messages:**
  - Stage with empty name is not allowed.
  - Stage with empty value is not allowed.
  - Cannot have more than one stage with the same name: x.
  - Cannot have more than one stage with the same value: y

- **Suggested Action:** If this is not by design, make the appropriate changes.
- **Publishable:** Yes
- **Runnable:** Yes
- **Related Information:** Workflow activities

Troubleshooting

Use the following procedure to troubleshoot this validator:

1. Open and check out a workflow.
2. Open the list of stages for the workflow by clicking the menu icon and selecting **Edit Stages**.
3. Check the names and values.
   
   Ensure that the names and values are unique and are not empty.
4. If the same stage name or value appears more than once, remove one of the rows. It is then very important to go through the workflow and reassign stages in the activities that used the removed stage.

Validate Workflow State Values

Tip: Make a list of which activities assign which stages.

Workflow concepts

You can do many things using the Workflow Editor.

• Modify core activities and exit conditions.
• Create custom activities and reuse the data for other workflows.
  See Orchestration activity designer.
• Download activity packs from the ServiceNow Store and create packs for upload.
• Edit workflows graphically.
• Define transitions between workflow activities.
• For the table that corresponds to the workflow, customize business rules.
• Summarize workflow progress through stages.
• Validate workflows to identify potential problems.
• Publish workflows for other users.
• Edit multiple tables without needing to directly modify them.

Workflow versions

To prevent users from making changes to a workflow that affect other users of the system, workflows must be checked out before they can be edited.

Only one user can check out a workflow at a time. When a workflow is checked out, changes apply only to the user who has the workflow checked out. Other users can continue to use the published workflow. After the changes are complete, the workflow can be published so that it is available to all users.

**Note:** Because each workflow has a unique sys_id, different workflows can have the same name. This is typically expected in a domain-separated environment where users in different companies cannot see each other's workflows because they are in different domains. However, this can lead to confusion in other environments. In general, give each workflow a unique name to prevent workflow designers from making changes to the wrong workflow.

When a new version of an existing workflow is published, the changes are not applied to running workflow contexts. Any currently running workflow context continues using the workflow version that was available when the workflow started. The next time the workflow runs, it uses the updated, published version.

Workflow scope

Workflow application scope determines the access that an application has to the information in a workflow, specifically to the data contained in the activities in that workflow.

When a workflow is created, it inherits the application scope from the gear menu for the logged in user. This scope cannot be changed in the Workflow Editor. When the workflow executes, it runs in this scope and can only be called from a different application if the workflow's accessibility setting permits access to all scopes (public). Otherwise, the workflow’s application scope is private to the application.

**Note:** Any script that is created in the Workflow Editor, such as an advanced script in an If activity, runs in the scope of the workflow. All core activities provided in the base system or for Orchestration run in the scope of the workflow.

Custom activities run in their own scope, even if it is different from that of the workflow. The scope of a custom activity can be private or public. Any script that runs inside a custom activity with a scope can only access outside artifacts that are within the scope of that activity or artifacts that are configured to run in any scope. Conversely, an outside artifact can only access the script inside that private activity if the outside artifact is running in the same scope. Activities with public scopes can interact with outside artifacts in any application scope.

You can use private activities as part of a workflow that has a public application scope. These activities are protected from reaching outside of the workflow or from being reached from outside the workflow.
For details about setting application scoping for custom activities, see the field description table for the appropriate activity template.

**Note:** Custom activities uploaded to the ServiceNow Store must be configured as accessible to all application scopes.

**Workflow scope restrictions**

There are some restrictions to public and private application scopes.

During runtime, publicly scoped workflows can access other application resources, as long as these resources are set to be accessible to all application scopes. Privately scoped workflows in a private application scope can only access resources private to its scope. Due to scope access boundaries, any privately scoped workflows that make calls out to other scoped resources fail with either an exception or a hung activity while waiting for returned results. This occurs when making calls to these common global resources:

- ECC queues
- Tasks
- Approvals
- Events
- SLA timers
- Timers
- Script includes
- Business rules
- Workflow APIs

As you design workflows, validate the visibility and accessibility of all resources prior to deployment.

See Application scope.

For information on how to configure the scope for a workflow, see Workflow properties.

**Domain separation and Workflow**

This is an overview of domain separation and the Workflow application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Overview**

**Support: Data only**

When domain separation is enabled, workflows and workflow activities inherit the domain of the user who publishes or creates them.

**How domain separation works in the Workflow application**

While workflows are managed by multiple tables, only the following tables are used for domain separation features:

- **Workflow [wf_workflow]** and **Workflow Version [wf_workflow_version]**: used for delegated administration or process separation.
- **Workflow Context [wf_context]**: used for data separation.
The Workflow Editor displays a workflow's domain in the title bar after the workflow name.

Workflow editor domain

**Workflows and delegated administration**

Delegated administration allows child domains to inherit workflows from higher up the domain hierarchy and to override them with domain-specific versions if necessary.
Workflow and delegated administration

Workflow records in the Workflow [wf_workflow] and Workflow Version [wf_workflow_version] tables are considered processes. A user in a child domain may check out but not copy a workflow from a parent domain. When a user in a child domain checks out a workflow from a parent domain, the system creates a version of the workflow in that user's domain. This new version is a unique record in the Workflow [wf_workflow] table. After the user publishes this new workflow, other users in the child domain use the
new workflow, which overrides the workflow from the parent domain. The original workflow in the parent domain is no longer visible to users in the child domain.

For example, a managed service provider (MSP) hosts ITSM services for several companies, including ACME and Initech, on a single instance. As administrators, the MSP creates a Change Request - Emergency workflow that applies to all domains because it was created in the TOP domain, which is the highest domain in the domain hierarchy. This workflow overrides the global Change Request - Emergency workflow and specifies that emergency change requests require approval from the CAB approval group. Because of delegated administration, every domain in the hierarchy sees and uses this workflow. Now suppose the ACME domain requires a different approval policy where emergency change requests require approval from the emergency CAB approval group. The MSP creates another version of the Change Request - Emergency workflow in the ACME domain. This workflow overrides the version in the TOP domain and only applies to users in the ACME domain.

Workflow permissions

When a user starts a new workflow, the workflow runs with that user's domain and credentials. The workflow preserves a user's domain and credentials until an activity causes the workflow to wait, such as an approval activity waiting for approval or rejection. When the stopped workflow resumes, such as when a user approves a request, the workflow uses the credentials of the approving user, but continues to run within the domain of the original user.

Workflows and data separation

Data separation restricts workflow contexts to users who are either in the same domain of the workflow or are members of a parent domain.
Workflow and data separation

Workflow records in the Workflow Contexts [wf_contexts] table are considered data. Data separation restricts workflow contexts to users who are either in the same domain of the workflow or are members of a parent domain. While a user in a parent domain can see running workflows in a child domain, a user...
in a child domain cannot see running workflows in a parent domain. If necessary, administrators can use visibility or contains domains to expand who can see domain-specific data.

For example, when an ACME user requests something from the service catalog, a Service Catalog Request workflow context is created in the ACME domain. Similarly, a service catalog request from an Initech user creates a workflow context in the Initech domain. An MSP user in the TOP domain can see both workflow contexts because it is the parent domain for both the ACME and Initech domains. However when an ACME or Initech user logs in, data separation prevents them from seeing each other’s service catalog requests. This is expected behavior because each workflow context contains data specific to that domain, such as the item requested and the request's approval history.

**Workflow engine operation order**

The workflow engine runs in a predefined order relative to business rules and database operations. It caches commonly-used published workflows to improve performance.

The **Run after bus. rules run** workflow property defines if a workflow is **Default** or **Deferred**.

The diagram below shows the workflow engine order of operations and when Default and Deferred flows are executed. For a more general overview of engine operation order, see #unique_3222.
Before business rules (order <1000)
Do not use current.update() here

Default workflows
Do not use current.update()

Before business rules (order >=1000)
Do not use current.update()

Database operation (insert, update, delete)
The current record is inserted or updated at the end of the database operation.

After business rules (order <1000)
Use current.update() if there is no deferred workflow

Deferred workflows
Do not use current.update()
Workflow caching

The workflow engine caches commonly-used published workflows to improve performance.

Caching significantly reduces the number of database queries per workflow. By default, the engine caches up to 300 unique workflow versions. Caching very large workflows may reduce this number as the cache size cannot exceed the Java Virtual Machine (JVM) heap size.

To change the maximum number of cached workflow versions, navigate to Workflow > Administration > Properties and modify the value of the The max number of models that will be concurrently held in the LRU cache (glide.workflow.model.cache.max) property. You must restart the instance to apply this change.

Workflow tables

For full flexibility, workflows store information over a number of different tables.

Usually tables containing workflow information are not edited one-by-one. Instead, use the Workflow Editor to edit workflows. The following lists are provided for reference purposes.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflows</td>
<td></td>
</tr>
<tr>
<td>Column Renderer [column_renderer]</td>
<td>A renderer widget for a stage column. Stage renderers are written in Jelly as a UI Macro. The default is Workflow-Driven; it covers most workflow related stage scenarios.</td>
</tr>
<tr>
<td>Version [wf_versionable]</td>
<td>Tracks different versions of element definitions [wf_element_activity].</td>
</tr>
<tr>
<td>Workflow [wf_workflow]</td>
<td>The master records of workflows.</td>
</tr>
<tr>
<td>Workflow Binding [wf_workflow_binding]</td>
<td>History of workflows run and the triggering record. Workflow Binding records prevent the system from running workflows again when the associated Workflow Context record has been deleted.</td>
</tr>
<tr>
<td>Workflow Context [wf_context]</td>
<td>Individual instances of a workflow being used.</td>
</tr>
<tr>
<td>Workflow Execution [wf_workflow_execution]</td>
<td>Synthetic &quot;current&quot; records for workflows that run on Global.</td>
</tr>
<tr>
<td>Workflow Instance [wf_workflow_instance]</td>
<td>Connections of workflows to subflows.</td>
</tr>
<tr>
<td>Workflow Version [wf_workflow_version]</td>
<td>Particular versions of a workflow, either published versions or versions that have been checked out.</td>
</tr>
<tr>
<td>Activities</td>
<td></td>
</tr>
<tr>
<td>Activity Variables [wf_activity_variable]</td>
<td>Variables for activities.</td>
</tr>
<tr>
<td>Workflow Activity [wf_activity]</td>
<td>Activities as they are being used in workflows.</td>
</tr>
<tr>
<td>Workflow Activity Definition [wf_activity_definition]</td>
<td>Definitions of activities that can be used in a workflow.</td>
</tr>
<tr>
<td>Workflow Executing Activity [wf_executing]</td>
<td>Individual instances of activities being performed in active contexts.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Workflow components</td>
<td></td>
</tr>
<tr>
<td>Element Provider [wf_element_provider]</td>
<td>Template definitions for custom activities.</td>
</tr>
<tr>
<td>Variable [item_option_new]</td>
<td></td>
</tr>
<tr>
<td>Workflow Condition [wf_condition]</td>
<td>All of the defined conditions in workflows.</td>
</tr>
<tr>
<td>Workflow Queued Command [wf_command]</td>
<td>Temporary internal storage for workflows that are currently executing.</td>
</tr>
<tr>
<td>Workflow SC Variable [wf_variable]</td>
<td>The Service Catalog variables for a workflow.</td>
</tr>
<tr>
<td>Workflow Schedule [wf_workflow_schedule]</td>
<td>Definitions of the times to run specific workflows.</td>
</tr>
<tr>
<td>Workflow Transition [wf_transition]</td>
<td>All of the defined transitions in workflows.</td>
</tr>
<tr>
<td>History</td>
<td></td>
</tr>
<tr>
<td>Workflow Activity History [wf_history]</td>
<td>The history of executed activities.</td>
</tr>
<tr>
<td>Workflow Log Entry [wf_log]</td>
<td>All of the events and history of the workflow.</td>
</tr>
<tr>
<td>Workflow Transition History [wf_transition_history]</td>
<td>The history of executed transitions.</td>
</tr>
<tr>
<td>Stages</td>
<td></td>
</tr>
<tr>
<td>Stage Default [wf_stage_default]</td>
<td>Definitions of default stage fields for tables to use.</td>
</tr>
<tr>
<td>Stage Set [stage_set]</td>
<td>A named set of stages that can be used to populate workflow stages for multiple workflows.</td>
</tr>
<tr>
<td>Stage Set Entry [stage_set_entry]</td>
<td>The stages that belong to a named stage set.</td>
</tr>
<tr>
<td>Stage Set for Table [stage_set_table]</td>
<td>Defines a relationship of a stage set to a table so that the stage set can be used as the default stages when a new workflow is created for the table. This replaces the wf_default_stage table and is the view that shows when you click <strong>Default Stages (by table)</strong> in the menu.</td>
</tr>
<tr>
<td>Workflow Stage [wf_stage]</td>
<td>Definitions of stages used by workflows.</td>
</tr>
</tbody>
</table>

**Workflow administration**

Tailor workflows exactly the way you want them.

**Workflow roles**

Certain roles are required to use workflows.
### Workflow roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity creator [activity_creator]</td>
<td>Creates and edits custom workflow activities, reuses custom activity data, and manages activity packs downloaded from the ServiceNow Store.</td>
</tr>
<tr>
<td>Web service administrator [web_service_admin]</td>
<td>Accesses and uses REST and SOAP messages in the Orchestration activity designer. Creates and edits custom activities that use the REST web service and SOAP web service templates.</td>
</tr>
<tr>
<td>Workflow administrator [workflow_admin]</td>
<td>Creates, edits, publishes, and deletes graphical workflows.</td>
</tr>
<tr>
<td>Workflow creator [workflow_creator]</td>
<td>Creates new graphical workflows.</td>
</tr>
<tr>
<td>Workflow publisher [workflow_publisher]</td>
<td>Publishes graphical workflows.</td>
</tr>
</tbody>
</table>

#### Warning:

Granting this role to a user is equivalent to giving the user the admin role, because workflow Script activities bypass access controls and grant access to all tables and database operations. Script activities do not bypass application scope settings.

---

### Administering workflow contexts

The workflow context performs the activities and transitions defined in the workflow with the new record as current.

Workflow in ServiceNow names a running workflow a Workflow Context. The Workflow Context maintains the state of the overall process in the Workflow Context record. The Workflow Context maintains the state of the individual activities as they execute in a series of related lists. These lists maintain the state of currently executing activities, the result of finished activities, and the execution path the workflow took through the process model.

The Workflow Context canvas provides a visual representation of the execution path the workflow took through the process model. The state of each activity (finished, executing, cancelled, error) is represented using the color palette. The executed paths are represented in the color blue; the non-executed paths are represented in grey. Active and historic workflow contexts, as well as the activities within them, can be viewed using the Live Workflows section of the Workflow application menu.
Viewing a workflow context

Workflow contexts can be found in two places:

- From the Workflow Context related link on the form of the task being powered by the workflow.
- By navigating to Workflow > All Contexts and selecting an active context.

Displaying workflow progress

Two related links on the Workflow Context form allow you to view the progress of a workflow in different formats.

- Show Timeline displays the workflow context as a timeline.
- Show Workflow displays the workflow context in the graphical Workflow Editor.

Graphical interface

To view the workflow context in the graphical Workflow Editor interface, click the Show Workflow link from either the workflow context record or the current record.
**Show workflow**

In the top right hand corner are two controls:

<table>
<thead>
<tr>
<th></th>
<th>Refreshes the workflow context.</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Refresh]</td>
<td>![Display Colors]</td>
</tr>
<tr>
<td>![Refresh]</td>
<td>Displays a key of the colors used in the workflow to denote the state of activities and transitions:</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Execution order

View tooltip text in the workflow context graphical view to see the execution order of individual activities.

In Workflow > Live Workflows > Active Contexts or All Contexts, Open the context you want to examine. Click Show Workflow, and point to a finished or executing activity. The tooltip shows error data, execution time, and the order in which the activity executed in the workflow. Use this data to help troubleshoot activities in an error state.
Cancel a workflow

Canceling a workflow stops the workflow from executing and sets the workflow context State to Canceled. To cancel an executing workflow, you can use the cancelContext(context) script. You can define an onCancel script to clean up unresolved workflow activities.

Canceling a workflow attempts to stop the workflow gracefully by injecting a cancel command into the workflow engine.

1. Navigate to Workflow > Active Contexts.
2. Select a workflow context record.
3. Select the Cancel related link.
   A confirmation window appears.
4. Click **OK**.
The Wait for Cancel window appears. The workflow engine attempts to cancel the workflow gracefully.

If the workflow does not respond to the cancel command, the Force Cancel window appears.
5. Click **Force cancel** to interrupt the thread the workflow is actively executing or click **Continue waiting** to continue waiting for the workflow to cancel gracefully.

**Warning:** Whenever possible, allow a workflow to cancel gracefully. Forcing a workflow to cancel can leave related workflows and scripts in an unresolved state. You can use an on-cancel script to clean up unresolved artifacts from a cancelled workflow.

To cancel an executing workflow, you can use the `cancelContext(context)` script. This script can be useful in cases where a workflow must be canceled in response to an event or where a user must manually cancel a workflow.

For more information, see the API reference.

**Define an on-cancel script**

Canceling a workflow can leave records or scripts in an unresolved state. For example, canceling a service catalog workflow may leave catalog items in the requesting user's cart. An administrator can specify an On-cancel script that runs when the workflow transitions to the Canceled state. This script can notify users, log information, or resolve the state of any scripts run within a workflow activity. The `sys_id` of the workflow context is available in this script using the `context_sys_id` variable.

On-cancel scripts run asynchronously from the global scope. Your instance workload determines when the system schedules and runs the on-cancel script.

**Important:** Since the system runs on-cancel scripts from the global scope, they cannot call or run scoped script includes.

1. Navigate to **Workflow > Workflow Versions**.
2. Select a workflow version that you have checked out. Workflow versions that are not checked out are not editable.
3. Edit the **On-cancel script** field. You may need to configure the form to add this field.
4. Click **Update**.

This example script adds a comment to a Requested Item [sc_req_item] record indicating the workflow for that request has been canceled.

```javascript
var grContext = new GlideRecord("wf_context");
grContext.get(context_sys_id);
var grReq = new GlideRecord("sc_req_item");

// The current record may not exist, make sure it exists before modifying it.
if (grReq.get(grContext.id)) {
    grReq.comments = "The workflow processing this item was Canceled. Contact your system administrator for further information.";
    grReq.update();
}
```

**Scheduling a workflow**

In addition to being run based on conditions, workflows can also be scheduled to perform at a particular time, similar to a scheduled job.
Scheduled workflows do not have a defined current record and do not run on specific records within a table. Due to this behavior, certain activities that depend on a current record, such as **Create Task** or **Catalog Task** are unavailable on scheduled workflows. If your workflow requires one of these activities, consider using a scheduled job that inserts a record to start the workflow instead of using a scheduled workflow.

To schedule a workflow, navigate to **Workflow > Scheduled Workflows** and click **New**. Populate the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the scheduled workflow.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Select an existing published workflow to be triggered at the specified date, time, or interval.</td>
</tr>
<tr>
<td>Active</td>
<td>If selected, the scheduled workflow will be triggered at the appropriate time.</td>
</tr>
<tr>
<td>Application</td>
<td>Specifies the type of application, such as Global.</td>
</tr>
<tr>
<td>Run</td>
<td>A choice list to determine when the workflow should be triggered. Options are:</td>
</tr>
<tr>
<td></td>
<td>• Daily: At a particular hour every day.</td>
</tr>
<tr>
<td></td>
<td>• Weekly: On a particular day of the week.</td>
</tr>
<tr>
<td></td>
<td>• Monthly: On a particular day of the month</td>
</tr>
<tr>
<td></td>
<td>• Periodically: After every set duration.</td>
</tr>
<tr>
<td></td>
<td>• Once: At one specific date and time.</td>
</tr>
<tr>
<td>Time</td>
<td>For daily/weekly/monthly scheduled workflows, the time of day to run the workflow.</td>
</tr>
<tr>
<td>Day</td>
<td>For weekly scheduled workflow, the day of the week to run the workflow.</td>
</tr>
<tr>
<td>Repeat Interval</td>
<td>For periodical workflows, the interval between workflows, beginning from the Starting date and time.</td>
</tr>
<tr>
<td>Starting</td>
<td>For periodical workflows, the first date and time to run the workflow.</td>
</tr>
</tbody>
</table>

**Workflow movement with update sets**

The system tracks workflows in update sets differently than other records because workflow information is stored across multiple tables.

Changes made to a workflow version are not added to the update set until the workflow is published, at which point the entire workflow is added into the update set. Update sets store workflows as a single Workflow [wf_workflow] record and only retain the latest version with the update type of Workflow. For information about update sets, see **System update sets**.

**Workflow update set migration use case - simple**

Create a new workflow with no dependencies and then migrate the workflow in an update set.

1. User A selects Update Set A.
2. User A creates a new workflow called Workflow A.
3. User A publishes Workflow A.
   A customer update set record is added to Update Set A containing an XML payload, including the
   published Workflow A and all activity dependencies. The XML payload also contains the workflow
   input variables associated with the workflow.

4. User A completes Update Set A and migrates it to the production instance.

5. Update Set A commits successfully.

6. Workflow A works as expected.

**Workflow update set migration use case - subflow dependency (success)**

Successfully edit and migrate an existing workflow and its dependent subflow.

1. User A selects Update Set B.

2. User A checks out Workflow A.

3. User A adds a subflow called Workflow B to Workflow A.
   Assume that Workflow B was previously published and migrated to the production instance.

4. User A publishes Workflow A.
   A customer update set record is added to Update Set B containing an XML payload, including the
   published Workflow A and all activity dependencies. The XML payload also contains the workflow
   input variables associated with the workflow.

5. User A completes Update Set B and migrates it to the production instance.

6. Update Set B commits successfully.

7. Workflow A works as expected with Workflow B as a subflow.

**Workflow update set migration use case - subflow dependency (failure)**

Edit and migrate an existing workflow from a test instance to a production instance that fails to run on the
production instance because of a missing dependent subflow.

1. User A selects Update Set C.

2. User A checks out Workflow A.

3. User A adds a subflow called Workflow B to Workflow A.
   Assume that Workflow B was previously published, but has not been migrated to the production
   instance.

4. User A publishes Workflow A.
   A customer update set record is added to Update Set C containing an XML payload, including the
   published Workflow A and all activity dependencies. The XML payload also contains the workflow
   input variables associated with the workflow.
   Notably absent from Update Set C is the subflow called Workflow B. Workflow B was published before
   User A selected Update Set C.

5. User A completes Update Set C and migrates it to the production instance.

6. Update Set C commits with warnings.

7. Workflow A is invoked on the production instance with the following results:
   Workflow A fails the runtime validation check and is prevented from running on the production system.
   The system adds to the workflow context a workflow log entry detailing the cause of the failure, notably
   the absence of a dependent workflow.
Workflow update set migration use case - subflow dependency (risk)

Multiple users migrate a workflow from a test instance to a production instance without proper coordination. This use case can succeed, but only when each user understands the dependencies and properly migrates the dependent parts of the workflow to the new instance.

This example does not represent an update set failure, although update sets are most often blamed in this use case. Validation increases the visibility of workflow dependencies across multiple update sets and provides designers with better information. In most cases, the warnings do not prevent an action, but only identify risk. The designer is responsible for taking action on advice given in the validation checks.

1. User A selects Update Set C.
2. User A checks out Workflow A.
3. User A adds a subflow called Workflow B that returns a User ID.

**Note:** Assume that Workflow B was previously published and migrated to the production instance.

4. User A uses the return value of Workflow B to generate approvals.
5. User B selects Update Set D.
6. User B checks out Workflow B (the subflow in Workflow A).
7. User B modifies the return value of the workflow by changing it from a User ID to a String Message.
8. User A publishes Workflow A.

**Note:** A dialog box displays warnings associated with Workflow A and encourages User A to validate the workflow before publishing.

9. User A cancels publishing and validates Workflow A.
10. User A is warned that Workflow B was modified by a user in a different update set.
11. User A ignores this warning and publishes Workflow A.

**Note:** A customer update set record is added to Update Set C containing an XML payload, including the published Workflow A and all activity dependencies. The XML payload also contains the workflow input variables associated with the workflow.

12. User A completes Update Set C and migrates it to the production instance.
13. Workflow A is invoked on the production instance and runs successfully using the older version of Workflow B already on the system.
14. User B publishes Workflow B.

**Note:** User B is not warned of the Update Set C dependency, because the update set is no longer In progress. However, User B is informed via a dialog box that there are warnings associated with the workflow version and is instructed to validate Workflow B. If User B cancels publication and validates the workflow, User B is warned that there are workflows that use Workflow B as a subflow. Knowing the return value was changed, User B should test those workflows as well. See ValidateUpdateSetDependencies to understand the parameters of update set warnings.
15. User B finally publishes Workflow B.

Note: A customer update set record is added to Update Set D containing an XML payload, including the published Workflow B and all activity dependencies.

16. User B completes Update Set D and migrates it to the production instance.

17. Update Set D commits without warnings.

18. Workflow A is invoked on the production instance and fails to run successfully, because the return value of Workflow B no longer generates a User ID.

Input variable movement

You can add input variables to existing workflows and add them to update sets.

When you submit the new variables, an entry is made into the current update set that reflects the addition of a variable to the Variables [var_dictionary] table. Unlike the workflow version that only writes to the update set when the workflow is published, the variables write individual update entries into the currently selected update set immediately upon submission.

Input variable movement use case - two input variables

An existing workflow already contains two input variables.

1. User A checks out the workflow.

2. User A adds two input variables.

   ServiceNow adds to the current update set one customer update record for each new variable.

   The current workflow now has 4 input variables: the two that were present prior to check out and the two new ones.

3. User A publishes the workflow.

   There are now three related customer update records: two for new variables, and one for the published workflow. The XML payload of the new workflow version now includes all input variable database entries. So while the two original input variables do not have individual customer update records, all four variables are migrated to the local instance with the payload of the newly published workflow version.

4. Verify variables included in a specific workflow.

5. User A completes the update set.

6. Adding Input Variables - Success

   User A migrates and commits the update set to a local instance where the original workflow version had previously been committed.

   • The two existing input variables are already present because of the earlier version.
   • The system adds the two new input variables when the user commits the update set.
   • The system preserves the two legacy input variables on the instance receiving the update set. The update set does not overwrite these variables.
   • The new published workflow version uses all four variables.
   • The user tests the new workflow version and it runs as expected.
Verify variables included in a specific workflow
You can verify the variables that are included in a specific workflow.

1. Navigate to System Update Sets > Local Update Sets.
2. Select the active update set.
3. Select the customer update entry for the workflow.
4. View the XML Payload.
5. Search for the name of one of the columns or search for var_dictionary.
   There is one var_dictionary entry for each input variable.

Input variable removal
Deleting workflow input variables, like insert and update actions, creates a customer update record in a user's current update set.

These deletions migrate to a new instance with the update set, regardless of whether the workflow that owns the input variables is published in the same update set. Plan carefully and use caution when editing a workflow and selecting update sets.

Input variable removal risk
An existing workflow already contains two input variables.

1. The workflow was migrated to a production instance with the two variables.
2. On a development instance, User A selects Update Set A and checks out the workflow.
3. User A removes one input variable and all references to it in the workflow.
   The system enters into Update Set A one customer update record reflecting the deletion of the input variable. No record is added for the new workflow version which no longer depends on the input. This does not happen until the workflow is published.
4. User A continues working on other features in Update Set A that need to be moved to production.
5. User A completes Update Set A and migrates it to the production instance without publishing the workflow.
   The update set entry that deletes the workflow input variable now applies to the production instance. The prior version of the workflow is running on this instance and still references the missing variable.

Input variable removal solution
When editing workflows, particularly when deleting input variables, be sure to use a single update set for all variable editing and workflow publishing.

If necessary, merge the update set into a more general set targeted for deployment after the workflow is published. For information about update sets, see System update sets.

Note: If a workflow version is already running on a production system and input variables are deleted from a newer version, those deletions could affect transactions already running against the earlier version. Use extreme caution when deleting workflow input variables and plan the migration carefully.

Input variable removal prevention
Prior to publishing a workflow version, the system validates the workflow model to assist the designer in planning for deployment.

This validation warns of critical errors that can prevent a workflow from running successfully, but also warns of dependencies and conflicts in update sets. See ValidateUpdateSetDependencies for more details.

© 2021 ServiceNow, Inc. All rights reserved.
Avoiding duplicate workflows

Update sets manage the published state of all versions of a workflow prior to committing the workflow version on a local instance.

The last version of a workflow committed as an Insert or Update using an update set becomes the currently published version, regardless of the publishing sequence for the workflow versions.

_Commit a workflow in an update set_

Follow the steps in this page to commit a workflow in an update set.

1. Workflow A - Version 1 is created and published in Update Set A.
2. Update Set A is completed and migrated to a local instance.
3. When the update set is committed, the system sets all prior versions of Workflow A to published = false.
   In the first migration, there are no prior versions.
4. Workflow A - Version 1 becomes the only published version of the workflow.

_Update set migration example_

It is not possible to have multiple published versions as a result of update set commits. However, this does not eliminate risk, and care should be taken when migrating update sets.

Consider this example:

1. Workflow A - Version 1 is migrated and committed to the production instance.
2. Update Set B is created.
3. Update Set C is created.
4. Workflow A - Version 2 is published in Update Set B.
   A customer update record is added to Update Set B with the Version 2 payload.
   A customer update record is added to Update Set B with the Version 1 workflow left unpublished.
5. Update Set B is completed.
6. Workflow A - Version 3 is published in Update Set C.
   A customer update record is added to Update Set C with the Version 3 payload.
   A customer update record is added to Update Set C with the Version 2 workflow left unpublished.
7. Update Set C is completed.
8. Update Set C is migrated and committed to the production instance.
   Workflow A - Version 1 is set to unpublished.
   Workflow A - Version 2 update is skipped since Update Set B, which contains Version 2, was never migrated.
   Workflow A - Version 3 is committed and becomes the only published version of the workflow.

_Update set migration risk_

Update Set B is migrated and committed to the production instance.

1. Workflow A - Version 3 is set to unpublished.
3. Workflow A - Version 2 is committed and becomes the only published version of the workflow. The workflow has gone back a version, perhaps unintentionally. The regressed version becomes the currently published version.

**Workflow timelines**

The system provides a timeline view of history activities associated with a workflow context. Timelines display a linear calendar of activities, such as tasks and approvals, defined by their start and end dates. Each activity on the timeline is represented by a span, which is displayed as a horizontal, colored bar. Each span has a label and a tooltip that contains additional information about the activity. The left pane displays all the activities in the context (or contexts) in an expandable hierarchy. You can change the timeline’s perspective for a more granular view of the data.

*Note:* Workflow timelines reflect context history only and are not real-time gauges of workflow activity.

**Use a timeline**

By default, the timeline displays all activities and transitions requested when first opened. Collapse any part of the hierarchy in the activity pane and the timeline adjusts automatically. Date/time and duration controls enable you to scale the timeline to view all the elements at once. To display a timeline, click a UI action within a Workflow Context record.

1. Navigate to **Workflow > Live Workflows > Active Contexts.**
2. Select a context.
3. In Related Links, click Show Timeline to display the timeline for the entire context.

The timeline opens with all activities expanded and the view set to Max, which displays the entire timeline at the width of the pane. The title of the timeline is in the form Workflow context: <context name>, Requested Item: <requested item number>.

4. Use the Range Selectors at the top of the timeline to change the perspective.

The increments go from one day to one year. To limit the timeline to an increment between the start date of the first span and the end date of the last span, click Max.

5. Use the starting and ending calendar fields to select the timeline perspective.

These fields control the same perspective as the slider at the bottom of the timeline.
6. Use the pink slider at the bottom of the timeline to change the perspective.

   a. Move the slider from right to left to view all the spans on a long timeline.
   b. Adjust the end points of the slider to make arbitrary changes to the magnification.
      A narrow slider zooms in on the spans and provides a more detailed view of complex timelines. A wide slider pulls the view out and makes more of the timeline visible on the screen.

7. To focus the timeline view on selected activities, expand or collapse the activity tree.
   Spans not visible in the activity tree are not shown in the timeline pane.
8. Hover over an activity span to display a tooltip with information about the activity. This action highlights the activity in the activity pane.

9. Hover over the transition between two activities to highlight the activity and the predecessor activity in the activity pane.
10. Double-click a span to display a history record for that activity. History records show information such as the **State** and the starting and ending times.

**Timeline for a selected activity**

You can display a partial workflow timeline.

1. Navigate to **Workflow > Live Workflows > Active Contexts**.
2. Open a Workflow Context record.
3. On the **Workflow Activity History** related list, select one or more individual activities.
4. Click **Show Timeline** from the action menu.

The resulting view is a snapshot of the timeline, showing only the selected activities and their transitions, if any.
5. Collapse the tree to confine the view even further.

View subflows in a workflow timeline

In a workflow timeline, subflow spans appear as a different color than the activities of the main workflow.

6. To view a timeline displaying activities from different contexts:
   You might use this feature to display a subflow’s context with the parent workflow context.
   a. Navigate to Workflow > Live Workflows > History.
   b. Select individual history items from the list.
   c. Select the Show Timeline option from the actions menu.

   History items are arranged in a hierarchy in the activities pane under their contexts. The timeline title is Multiple Contexts. The timeline draws only the activities and relationships of the history items selected.
Workflow timeline subflow

**Workflow error handling**

The personalized JavaScript that users create in workflow activity variables is vulnerable to run-time syntax errors. Available error information is available in a tooltip when you point to a workflow activity in an error state.

In the base system, workflow activities do not provide condition routing on the error state. As a result, the workflow progresses based on the state of the current record. For example, a workflow contains an Approval - User activity that uses an advanced script to add additional approvers. A syntax error in the script results in no approvers being added. Because a state of no approvers is a valid return, even without the syntax error, the approval activity is skipped and the workflow progresses along a positive path. However, this might not be a valid response for the workflow designer who does not want the workflow to progress along the positive path without approvers.

Workflow error handling detects and logs syntax errors and provides a state that the workflow designer can use to add error conditions to the workflow. Use error handling to locate syntax errors in advanced script fields for these workflow activities:

- Approval - User
- Approval - Group
- Catalog Task
- Create Task
- If
- Run Script
- Notification
Available error information

This table shows which activities support error exits.

### Available error information

<table>
<thead>
<tr>
<th>Activity</th>
<th>Workflow log</th>
<th>Red error indicator</th>
<th>Activity state</th>
<th>Activity result</th>
<th>Fault description</th>
<th>Reroute on error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval - User Approval - Group</td>
<td>Yes</td>
<td>Yes</td>
<td>Error</td>
<td>Skipped</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Catalog Task Create Task</td>
<td>Yes</td>
<td>No</td>
<td>Finished</td>
<td>none</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>If</td>
<td>Yes</td>
<td>Yes</td>
<td>Error</td>
<td>none</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Run Script</td>
<td>No</td>
<td>Yes</td>
<td>Error</td>
<td>error</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Notification</td>
<td>Yes</td>
<td>Yes</td>
<td>Error</td>
<td>error</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Workflow error tracking features**

Error handling provides visual cues within the workflow, such as error descriptions for activities in pop-ups, and detailed log records.

**Banners**

Look for an activity with a red banner, indicating that a syntax error has occurred in a script field. All activities that provide error handling, with the exception of Catalog Task and Create Task, display a red banner for this error.

![Red banner](image)

**Tooltips**

Point to the activity displaying a red banner to view information about the error. A tooltip shows the State and Result of the activity and provides a brief Fault Description (except for task activities). Note that this approval continued as skipped despite the error given in the fault description. See Workflow error handling for the information available to each activity.
Execution order

Tooltip text in the Workflow Context graphical view displays the execution order of individual activities, which assists in troubleshooting.

To view the order in which a workflow activity was executed:

1. Navigate to **Workflow > Live Workflows > Active Contexts** or **All Contexts**.
2. Open the context you want to examine.
3. Click **Show Workflow.**
4. Hover the cursor over a finished or executing activity.

A tooltip appears showing error data, execution time, and the order in which that activity executed in the workflow. You can use this data to help troubleshoot activities in an error state.

**Workflow log**

View the log in the Workflow Context form for more information about the syntax error in the activity. Since task activities do not display a red banner when a syntax error has occurred, you must view the log if you suspect the workflow has not run properly. Examine the error description in the log, and then inspect the script in the activity named in the log.
To view the activity by name, navigate to **Workflow > Administration > Properties** and enable the **Log workflow debug messages** property.

In this example, an SSH activity named File Read specifies an invalid MID Server.

![Workflow Log example](image)

**Error handling log**

If the credentials used by an activity in the workflow fail, and the activity cannot authenticate on the target, a message describing the failure appears in the **Workflow Log** related list. The message displays the target IP address and the credential details.
Credential debugging in the workflow log

Create an error condition exit

An administrator can reroute the workflow when a script error occurs by creating an error condition exit for specific activities within the workflow. This allows the workflow to process script errors in a predictable way and not create undesirable results.

1. Open and check out a workflow.
2. Right-click in the top portion of the activity for which you want to create an error exit.
3. Select Add condition from the context menu.
4. Add a condition exit with the following values:
   - Name: Error
   - Condition: activity.state=='faulted'
5. Click Submit.
The Error exit appears on the activity.

6. Connect the Error exit to another activity for handling the error state, such as Notification or Log Message.

---

Reconfigure an approval condition

Approval activities react differently to script errors than the other activities.

Approval activity script errors can prevent an approval from being processed successfully. This, in turn, can cause the approval to complete as Skipped, which can appear to be an Approved state. To prevent this from happening, reconfigure the Approved exit as follows:

1. Open an approval workflow and make sure it is checked out.
2. On an approval activity, double-click the Approved exit.
3. Add the following script to the Condition field:

```
&& activity.state != 'faulted'
```

This prevents the activity from continuing down the normal path in an error state and ensures that Skipped or Approved is the desired state.

4. Click Update.

---

Workflow run time metrics

You can enable the collection of workflow run time metrics to determine whether workflows are performing as expected or consuming additional resources.

Outlying run times for a workflow are identified by comparing actual run times to an outlier range calculated with the outlier threshold and estimated run time defined in the workflow properties.

You can monitor the results of these metrics on the Workflow Operations Dashboard and custom homepages with workflow gauges.

---

Enable workflow run time metrics

Provide an estimated run time that can be compared to actual workflow run times.
For baseline workflows, you must also manually enable the collection of run time metrics. The system automatically enables the collection of run time metrics for new workflows.

1. Navigate to **Workflow** > **Workflow Editor**.
2. Open and check out the workflow.
3. In the title bar, click the menu icon and select **Properties**.
4. In the Workflow Properties dialog box, click the **Estimated Runtime** tab.
5. To enable the collection of run time metrics, check that the **Requires ERT** option is selected.
6. Open a configuration from the **Estimated Run Time** column.
7. In **Estimated Run Time**, enter an initial estimate for the workflow's run time.
   The system compares this initial estimate to actual run time results to create outlier reports. The system can automatically update this field in certain circumstances. Workflow designers can also manually update this field.
8. In the **Outlier Percentage Threshold for ERT** field, enter the percentage deviation from the estimated run time that identifies an outlier workflow run time.
   The system uses a default value of **20**.
9. Click **Update**.

**Outlying workflow run times**

Workflow run times are identified as outliers when they are longer or shorter than the outlier range that is computed for the workflow.

The outlier range is automatically computed with the **Estimated Run Time** and **Outlier Percentage Threshold for ERT** values in the workflow properties. These values are used in the following formulas.

**Formulas for computing workflow outlier ranges**

<table>
<thead>
<tr>
<th>Value computed</th>
<th>Computation used</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outlier Value</td>
<td><strong>Estimated Run Time</strong> * (Outlier Percentage Threshold for ERT / 100)</td>
<td>10 seconds * (20 / 100) 10 seconds * 0.2 = 2 seconds</td>
</tr>
<tr>
<td>Outlier Range</td>
<td>(<strong>Estimated Run Time</strong> - <strong>Outlier Value</strong>) to (<strong>Estimated Run Time</strong> + <strong>Outlier Value</strong>)</td>
<td>(10 seconds - 2 seconds) to (10 seconds + 2 seconds) = 8 to 12 seconds</td>
</tr>
</tbody>
</table>

When a workflow runs within the outlier range, its estimated run time is automatically updated.

If a workflow has an outlying run time, it appears in any outlier workflow gauges on the Workflow Operations Dashboard and custom home pages.

**Workflow estimated run time updates**

When a workflow runs within the outlier range, its estimated run time is automatically updated.

The estimated run time is updated with the cumulative moving average of the latest run time value in relation to previous run times. The computed value is rounded to the nearest second and stored as a **GlideDateTime**.

For example:

<table>
<thead>
<tr>
<th>Data point</th>
<th>Latest value</th>
<th>Cumulative running average (CRA)</th>
<th>CRA after rounding to the nearest second</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10 seconds</td>
<td>10 seconds</td>
<td>10 seconds</td>
</tr>
<tr>
<td>2</td>
<td>12 seconds</td>
<td>11 seconds</td>
<td>11 seconds</td>
</tr>
<tr>
<td>Data point</td>
<td>Latest value</td>
<td>Cumulative running average (CRA)</td>
<td>CRA after rounding to the nearest second</td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
<td>----------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>3</td>
<td>9 seconds</td>
<td>10.333 seconds</td>
<td>10 seconds</td>
</tr>
</tbody>
</table>

**Note:** Because the system rounds to the nearest second, the calculation is less precise with short durations.

You can also manually update the estimated run time in the workflow properties.

**Workflow pause utility**

Workflow Pause Utility provides functionality you can use to pause or resume all workflow contexts, a subset of qualified workflow contexts, or individual workflow contexts. You designate the data and time of day at which the paused workflows should resume, and can manually resume individual workflows as needed.

Once activated, the Workflow Pause Utility plugin (com.glideapp.workflow.pause) updates several tables when you pause or resume workflows. Each table stores specific data related to each paused or resumed workflow.

**wf_pause_request**

Records every workflow pause request. The system automatically updates and inserts records in this table whenever you pause workflow contexts. It tracks user-specified resume time, whether the pause request is still active, and the total number of workflow activities that paused or resumed.

**wf_pause_status**

Records the status of each workflow context you pause. When you pause workflow contexts, the plugin waits until the current executing activity finishes, and pauses it before the next activity starts. It tracks the specific activity on which the workflow context was paused and whether it has resumed. If the workflow is paused, it tracks the time at which it is scheduled to resume.

**wf_pause_group_request**

Pauses the specific set of workflow contexts you designate using filtering in Group Pause Requests. You can manually pause all currently active workflows by clicking the Pause All check box.

**wf_pause_snapshot**

Before pausing and after resuming a workflow, the table records a snapshot of the current state of the workflow context. The table also records the state of the currently executing activity on the paused workflow context.

**Use examples**

When you take down an instance for maintenance, you can pause all or selected active workflow contexts, and then resume them after you complete the maintenance.

You have an integration workflow context that hits an internal service that is down for maintenance. You can pause all instances of that workflow context from progressing to the next activity, allowing time for the internal service to be restored. Then, the paused workflow contexts can be resumed.
Activate workflow pause utility

You can activate the Workflow Pause Utility plugin (com.glideapp.workflow.pause) if you have the admin role. This plugin may include demo data and activates related plugins if they are not already active.

Role required: Workflow_admin or workflow_publisher, workflow_creator

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Pause and resume individual workflows

To pause individual workflow contexts, specify the date and time of day at which the workflow context should resume. When a workflow context is paused, the system saves basic information about the pause request, such as the resume date and time, in the wf_pause_request table. A workflow context automatically resumes at a specified date and time of day, but paused workflow context can be manually resumed as needed.

Role required: Workflow_admin or workflow_publisher, workflow_creator

Install and activate the Workflow Pause Utility plugin.

1. Navigate to Workflow > Live Workflows > Active Contexts.
2. Select the individual workflow context you are pausing.
   Workflow Context appears.
3. In Related Links, click Pause.
   A Workflow Pause Inputs dialog appears.
4. In the Workflow Pause Inputs dialog:
   a) Click to select the date, and enter the time of day (in hours, minutes, and seconds) at which the workflow should resume. You can select the current date or future date, but you must enter a time of day in the future.
      For example, to pause the workflow context at 13:30:00 (1:30 pm), select the date from the calendar, and then enter 13, 30, and 00 into the respective Time: fields.
   b) Click when finished.
   c) The selected date and time of day appear in the Resume At field.
   d) Click OK to return to Workflow Contexts.
      The selected workflow is now paused. Use Workflow pause request to monitor its status.
5. Paused workflows resume on the date and time of day specified in the Resume At field. To manually resume a currently paused workflow context:
   a) Navigate to Workflow > Live Workflows > Active Contexts.
   b) Select the individual workflow context you are pausing. Workflow Context appears.
   c) In Related Links, click Resume.

Pause and resume all or multiple workflows

Use Workflow Pause Group Requests to pause, or resume, groups of workflows, or all active workflows. If pausing a group of workflows, use filtering functions to select the workflows. If pausing all active workflows, select the Pause All check box to indicate that all currently active workflows should be paused.

Role required: Workflow_admin or workflow_publisher, workflow_creator

Install and activate the Workflow Pause Utility plugin.

1. Navigate to Workflow > Operations > Group Pause Requests.
   Workflow Pause Group Requests appears and displays existing workflow pause group requests.
2. Click New.
   Workflow Pause Group Request appears, and assigns a workflow pause group request ID.
3. To pause all active workflows, select Pause All, then click Update. To pause a filtered group of active workflow contexts, skip this step.
   All currently active workflow contexts in the instance are paused until you resume them. Use Workflow pause request to monitor their status.
4. To pause a filtered group of active workflow contexts, use the Filter field, specify the conditions for the search, then click Update.
   Workflow Pause Group Requests appears, and displays the results of the workflow group search. It assigns a workflow pause group request ID and indicates if the group is active (true = paused) or inactive (not yet paused).
5. To update, resume or delete a specific workflow pause group request, select it.
   Workflow Pause Group Request appears, and displays the selected workflow pause group request.
6. If the selected workflow pause group request is active (paused), and you do not want to pause it, click Do Not Pause Incoming Workflows. If the selected workflow pause group request is inactive (not yet paused), click Pause to pause it.
7. For the paused workflow group request, use the Resume At field to specify the date and time of day at which the paused workflow contexts should resume.
   a) Click to select the date, and enter the time of day (in hours, minutes, and seconds) at which the workflow contexts should resume. You can select the current date or future date, but you must enter a time of day in the future.
   For example, to pause the workflow context group at 13:30:00 (1:30 pm), select the date from the calendar, and then enter 13, 30, and 00 into the respective Time: fields.
   b) Click when finished.
   c) The selected date and time of day appear in the Resume At field.
d) Click **OK** to return to Workflow Pause Group Request.

8. Click **Submit**.

9. Paused workflow contexts automatically resume on the date and time of day specified in the **Resume At** field. To manually resume currently paused workflow contexts:
   a) Navigate to **Workflow Pause Group Requests**.
   b) Select the workflow pause group request to resume.
      **Workflow Pause Group Request** appears.
   c) Click **Resume**, and then click **Update**.

10. Workflow Group Pause Request also contains the following information fields.

    **Workflow group pause request form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Indicates if workflow group is paused.</td>
</tr>
<tr>
<td>Completed Resume Activity Count</td>
<td>Number of resumed workflow context activities that are completed.</td>
</tr>
<tr>
<td>Filter</td>
<td>Standard filtering fields used to specify the conditions for selection of a group of workflow contexts.</td>
</tr>
<tr>
<td>Log</td>
<td>Activity work notes generated by the group pause request.</td>
</tr>
<tr>
<td>Not Transitioned Workflow Count</td>
<td>Number of workflow contexts that were not transitioned when the group pause request was placed. When a group pause request is placed, the affected workflow contexts are paused before start of the next activity.</td>
</tr>
<tr>
<td>Resume Act Count</td>
<td>Number of workflow context activities resumed after the group pause completed.</td>
</tr>
<tr>
<td>Pause Act Count</td>
<td>Number of paused workflow context activities.</td>
</tr>
<tr>
<td>Requester Name</td>
<td>Name of the person requesting the workflow context pause.</td>
</tr>
<tr>
<td>Pause percentage</td>
<td>Total percentage of workflow contexts that are paused.</td>
</tr>
<tr>
<td>Resume Percentage</td>
<td>Total percentage of workflow contexts that have resumed.</td>
</tr>
<tr>
<td>Total Workflow Count</td>
<td>Total number of workflows matching the specified filter conditions that are being paused.</td>
</tr>
<tr>
<td>Paused Workflow Count</td>
<td>Number of current paused workflow contexts.</td>
</tr>
</tbody>
</table>

**Monitor workflow pause requests**

You can monitor the status of workflow pause requests using Workflow Pause Request.

Role required: Workflow_admin or workflow_publisher, workflow_creator

You must install and activate the Workflow Pause Utility plugin.

1. Navigate to **Workflow > Operations > Pause Requests**.
**Workflow Pause Requests** appears and displays existing workflow pause requests.

2. Select the workflow pause request.

**Workflow Pause Request** appears, and displays the selected workflow pause request.

**Workflow pause request fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Req Number</td>
<td>Unique assigned pause request number.</td>
</tr>
<tr>
<td>Completed Resume Activity Count</td>
<td>Number of workflow context activities resumed after the pause completed.</td>
</tr>
<tr>
<td>Pause Active</td>
<td>Selected indicates the workflow context is currently paused. Cleared indicates it is not.</td>
</tr>
<tr>
<td>Transitioned During Pause</td>
<td>Number of workflow contexts that transitioned when the pause request was placed. When a pause request is placed, the affected workflow contexts are paused before start of the next activity.</td>
</tr>
<tr>
<td>Workflow Context</td>
<td>Reference number for the paused workflow context.</td>
</tr>
<tr>
<td>Log</td>
<td>Activity work notes generated by the group pause request.</td>
</tr>
<tr>
<td>Paused Act Count</td>
<td>Date and time of day (h:m:s) at which the paused workflow context is resuming.</td>
</tr>
<tr>
<td>Requester Name</td>
<td>Name of the person who requested the workflow pause.</td>
</tr>
<tr>
<td>Resume Act Count</td>
<td>Number of workflow context activities resumed after the pause completed.</td>
</tr>
<tr>
<td>Resume At</td>
<td>Date and time of day (h:ms:s) at which the workflow contents are scheduled to resume.</td>
</tr>
<tr>
<td>Table</td>
<td>Related record table name.</td>
</tr>
<tr>
<td>Application</td>
<td>Application in which the workflow context is executing.</td>
</tr>
<tr>
<td>Exec Act Count</td>
<td>Number of activities executing when the workflow context was paused.</td>
</tr>
<tr>
<td>Group Pause Request</td>
<td>Reference number for the associated group pause request, if any. Appears only if pause request was the result of a group pause request.</td>
</tr>
<tr>
<td>Is Workflow Complete</td>
<td>Selected indicates the workflow context is complete. Cleared indicates it is not.</td>
</tr>
<tr>
<td>Is Workflow Stuck</td>
<td>Selected indicates the workflow context is stuck. Cleared indicates it is not.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the workflow context - Paused or Resumed.</td>
</tr>
<tr>
<td>Stuck Activities Count</td>
<td>The number of workflow context activities that are stuck.</td>
</tr>
<tr>
<td>Stuck Act Count To be subtracted for Pause Percentage</td>
<td>Writer to whom the documentation request is assigned.</td>
</tr>
</tbody>
</table>
Encrypted workflow scratchpad

The Encrypted Workflow Scratchpad plugin (com.snc.encrypted.scratchpad) provides encrypted scratchpad support for workflow context and workflow executing activities.

The platform supports encryption on most fields, and workflows can execute on tables with encrypted fields. Encrypted data is typically stored in the workflow scratch pad for workflows that execute using encrypted fields and must access this data after processing an approval, timer, or create task activity.

Data in the workflow scratchpad is not encrypted by default. The Workflow engine supports scratchpad encryption and executing activity records only when the Encrypted Workflow Scratchpad plugin is activated. Once activated, data stored in the wf_context and wf_executing scratchpads is protected by a private workflow engine encryption context, and is prevented from being stored in plain text.

Activate encrypted workflow scratchpad

Activate the Encrypted Workflow Scratchpad plugin (com.snc.encrypted.scratchpad) if you have an admin role.

Role required: admin

The Encrypted Workflow Scratchpad plugin must be activated via a ServiceNow Technical Support request. You should activate and thoroughly test the plugin in a non-production instance. Only after you satisfied with the results should you activate it in a production instance.

When activating it in a production instance, you should pick a low transactional volume time to do so. Prior to its activation, first activate the Workflow Pause Utility (com.glideapp.workflow.pause), and then pause all active workflows. Refer to Workflow pause utility. After activating the Encrypted Workflow Scratchpad plugin, resume all paused workflows.

Encrypted Workflow Scratchpad activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encryption Support</td>
<td>Allows text fields and attached files to be encrypted.</td>
</tr>
<tr>
<td>[com.glide.encryption]</td>
<td></td>
</tr>
</tbody>
</table>

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Once you install and activate the plugin, resume all paused workflows. Refer to Pause and resume all or multiple workflows.
Troubleshoot workflows

Troubleshooting tools for workflows enable administrators to isolate execution paths, compare contexts, and track incomplete activities.

The workflow timeline provides a visual representation of the workflow, including transitions and the elapsed time for each activity. A troubleshooting tool for highlighting execution paths helps users perform forensics on a workflow. The highlighting feature can group multiple execution paths in various colors and can isolate rollback processing. Use the workflow highlighter to isolate incomplete tasks and approvals. You can also enable a workflow performance timing feature to troubleshoot slow workflows.

Execution path troubleshooting in timelines

Use the controls in a workflow timeline to isolate specific execution paths or compare multiple execution paths over time.

Timelines show how the activities in the workflow progressed in relation to one another over time. Isolate execution paths and follow transition lines between subflows and the main flow. Processing times provide a view of the workflow that you cannot get from the workflow diagram. Tooltips give precise information about each activity, such as duration.

![Workflow timeline](image)

Workflow timeline troubleshooting

Execution history table

Highlight execution paths and rollbacks to locate activities that may have been left in an unresolved state.
Rollbacks, cancels, and deletions during the execution of a workflow can prevent some activities from fully completing. Use highlighting in the execution history table to determine which activities in the workflow were left in an unresolved state.

1. Run the workflow.
2. Navigate to Workflow > All Contexts.
3. Select a context to troubleshoot.
4. In the Workflow Context form, select the Workflow Activity History related list.
5. Right-click an activity and select Workflow Debug > Toggle Execution Path Highlighting from the context menu.

   All activities in that execution path are highlighted in a color selected by the platform. The debug path shows all activities that completed successfully during the workflow.

6. Right-click a rollback activity and select Workflow Debug > Toggle Rollback Highlighting from the context menu.

   The platform highlights the rollback path (restarted activities) in a different color. Each color represents a group of activities that were part of the same rollback execution. The highlighting includes the activity
that initiated the rollback. If you right-click an activity that was not part of a rollback, no rows are highlighted.

![Note: The rollback activity itself appears in both execution path and rollback highlighting.](image)

7. To remove highlighting, right-click in the list and select an option to clear execution path or rollback highlighting.

You can clear individual rollback paths or all rollback highlighting.

**Use the Workflow Operations Dashboard**

On the Workflow Operations Dashboard, view and add widgets to help you monitor workflows. Review the performance of workflows and determine which workflows must be improved.

Role required: workflow_admin

The different levels of access are:

- **View**: View the dashboard and refresh report widgets.
- **Customize**: Refresh, add, delete, and rearrange widgets.
On the Workflow Operations Dashboard, you can click widget elements to view the records they represent. You can also add new report widgets that are not displayed by default.


   The default reports on the dashboard include:
   - Workflow contexts providing run time metrics
   - Active workflows started during a specified time period
   - Workflows run between yesterday and today
   - Workflows by state for the current month
   - Aged workflow contexts for the past month

2. To find and add more widgets, click the Add Content icon ( ) in the upper left corner of the dashboard.

   If a workflow consistently appears as an outlier and there is no error causing the run time values, you can use its historical run time values to calculate a new estimated run time value. Then update the estimated run time in the workflow properties.

### Workflow gauges

Multiple gauges are available to help you review the performance of workflows. You can add these gauges to the Workflow Operations Dashboard or custom homepages.

#### Workflow gauges

<table>
<thead>
<tr>
<th>Content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERT Dashboard Controls &gt;</td>
<td></td>
</tr>
<tr>
<td>Outlier Finished Workflows for ERT (Percentage Outlier)</td>
<td>Identifies workflows that finished, but did not finish within estimated runtime (ERT) values. Enter an outlier percentage to see workflows that ran outside the specified runtime range.</td>
</tr>
<tr>
<td>Outlier Long Running Workflows for ERT (Percentage Outlier)</td>
<td>Displays workflows running longer than the configured runtime threshold.</td>
</tr>
<tr>
<td>Workflow Dashboard &gt;</td>
<td></td>
</tr>
<tr>
<td>Workflows Without Current Record</td>
<td>Displays workflow contexts that do not have an associated current record.</td>
</tr>
<tr>
<td>Gauges &gt; Workflow Context</td>
<td></td>
</tr>
<tr>
<td>Number of Active Workflows Started Hourly Over Time (Yesterday)</td>
<td>Displays the total number of running workflows per hour over a given time period. By default, it displays the number of workflows that ran per hour over the previous day (yesterday).</td>
</tr>
<tr>
<td>Outlier Finished Workflows Not Cumulated to ERT</td>
<td>Displays workflow contexts that are finished outside the estimated runtime outlier value and not cumulated to estimated run time value.</td>
</tr>
<tr>
<td>Running Workflow Contexts</td>
<td>Displays the total number of running workflows.</td>
</tr>
<tr>
<td>Content</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Successfully Finished Workflows Cumulated to ERT</td>
<td>Displays the total number of successfully completed workflows whose running duration is cumulated to the estimated run time value.</td>
</tr>
<tr>
<td>Workflows by State (This Month)</td>
<td>Displays the total number of workflows run in a month grouped by the current state.</td>
</tr>
<tr>
<td>Aged Workflow Contexts (Running Since Last Month)</td>
<td>Displays the total number of workflow contexts running for a given period of time by workflow name. By default, it displays the total number of workflow contexts running over the last month.</td>
</tr>
<tr>
<td>Workflows Run Between Yesterday and Today (by Table)</td>
<td>Displays workflows that have run in the last day grouped by table name.</td>
</tr>
</tbody>
</table>

**Workflow performance timing**

The workflow engine can generate detailed performance timing data that is useful for troubleshooting slow workflows.

An administrator must enable this functionality.

When workflow performance timing is enabled, the workflow engine tracks key performance data, including various execution speed metrics. The Workflow Timing [wf_workflow_timing] table stores the data, with a record for each workflow context. The workflow timing record is updated when the workflow engine completes the workflow, waits for an activity to complete, or otherwise exits the workflow execution.

**Workflow estimated run time properties**

Administrators can enable the collection of workflow run time metrics by setting Estimated Run Time (ERT) properties.

Administrators can use ERT metrics to determine if workflows are running longer or shorter than expected and to identify errors in workflow processing. The system displays run time metrics on the Workflow Operations Dashboard.

**Enable workflow performance timing**

Workflow performance timing is disabled by default. You can create a system property to enable it.

Role required: admin

#unique_1935 with the following specifications.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.workflow.show_timing</td>
</tr>
<tr>
<td>Type</td>
<td>true</td>
</tr>
<tr>
<td>Value</td>
<td>true</td>
</tr>
</tbody>
</table>

**Workflow activities**

Workflow activity properties reference
Each activity performs a different task, such as running a script, sending notifications, or requesting approvals. Activities can succeed or fail, which can result in actions performed by other activities.

For information about configuring different types of activities, click an activity name in the list below or see Workflow activities reference.

Core activities provided in the base system

• Approval and rollback workflow activities
• Condition Workflow activities
• Notification workflow activity
• Notify workflow activities
• Subflow activities
• Task workflow activities
• Timer workflow activities
• Utility workflow activities

Activities provided with Orchestration

The following activities are included with Orchestration.

• Active Directory activity pack
• Orchestration activities
• PowerShell activities
• Puppet activities

Templates provided for creating custom activities

If Orchestration is active on your system, users with the proper roles can create custom activities using the ServiceNow Orchestration activity designer. For information about the templates Orchestration provides for creating custom activities that you can upload to the ServiceNow Store, see Activity designer components.

Workflow activities reference

Workflow activity reference, organized by category.

Each activity performs a different task, such as running a script, sending notifications, or requesting approvals.

Workflow runs activities as the user session that starts or advances them. Workflows started from record operations will run activities as the user session that performed the record operation. Workflows started from schedules or restarted from timers run activities as the System user. Workflows started from script calls run activities as the user session that started the script.

Approval and rollback activities

Approval and rollback activities generate and manage approvals. Not all workflows can include approval activities. For more information, read Approval and rollback workflow activities.
**Note:** Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.

### Approval and rollback activities

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Action workflow activity</td>
<td>The <strong>Approval Action</strong> activity performs an approval action on the current task.</td>
</tr>
<tr>
<td>Approval Coordinator workflow activity</td>
<td>The <strong>Approval Coordinator</strong> activity creates an approval whose outcome depends on the outcome of one or more child activities, including one or more <strong>Approval - User</strong>, <strong>Approval - Group</strong>, and/or <strong>Manual Approval</strong> activities.</td>
</tr>
<tr>
<td>Approval - Group workflow activity</td>
<td>The <strong>Approval - Group</strong> activity creates approval records for each member of a specified group.</td>
</tr>
<tr>
<td>Approval - User workflow activity</td>
<td>The <strong>Approval - User</strong> activity creates one or more individual user approvals.</td>
</tr>
<tr>
<td>Generate workflow activity</td>
<td>The <strong>Generate</strong> activity immediately creates task or approval records from any task or approval activities placed after the <strong>Generate</strong> activity in the workflow path. These pre-generated tasks and approvals start when the task and approval activities are reached during flow execution. This allows a task to have a set of associated pre-generated sequential tasks or approvals, but still require them to be completed in order.</td>
</tr>
<tr>
<td>Manual Approvals workflow activity</td>
<td>The <strong>Manual Approvals</strong> activity watches and manages any approvals that users add manually outside of the workflow process. This activity only selects approvals that are in the Not requested state.</td>
</tr>
<tr>
<td>Rollback To workflow activity</td>
<td>The <strong>Rollback To</strong> activity transitions directly to the activity specified by the outgoing transition line arrow.</td>
</tr>
</tbody>
</table>

### Condition activities

Condition activities provide conditional branching and logical operation functionality for workflows.

**Note:** Condition activities run as the user whose actions match the conditions the workflow was waiting for and advances the workflow.

### Condition activities

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If workflow activity</td>
<td>The <strong>If</strong> activity checks a condition or script to determine if a <strong>Yes</strong> or <strong>No</strong> transition should be taken.</td>
</tr>
<tr>
<td>Switch workflow activity</td>
<td>The <strong>Switch</strong> activity checks if the value of a passed field or variable is equivalent to one of several case values.</td>
</tr>
<tr>
<td>Wait for condition workflow activity</td>
<td>The <strong>Wait for condition</strong> activity causes the workflow to wait at this activity until the current record matches the specified condition.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Notify activities

Notify workflow activities manage calls and SMS messages in Notify.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forward call workflow activity</td>
<td>The <strong>Forward Call</strong> activity forwards a Notify call to an E.164-compliant phone number.</td>
</tr>
<tr>
<td>Input workflow activity</td>
<td>The <strong>Input</strong> activity creates a phone menu by presenting a list of options on a Notify call.</td>
</tr>
<tr>
<td>Hangup workflow activity</td>
<td>The <strong>Hangup</strong> activity disconnects an active Notify phone call.</td>
</tr>
<tr>
<td>Play workflow activity</td>
<td>The <strong>Play</strong> activity plays a sound file on a Notify call.</td>
</tr>
<tr>
<td>Record workflow activity</td>
<td>The <strong>Record</strong> workflow activity records audio from a user on a Notify call.</td>
</tr>
<tr>
<td>Reject workflow</td>
<td>The <strong>Reject</strong> workflow activity rejects an incoming Notify call.</td>
</tr>
<tr>
<td>Say workflow activity</td>
<td>The <strong>say</strong> workflow activity allows you to play a message, using text to speech, on a Notify call.</td>
</tr>
<tr>
<td>Forward to notify client workflow activity</td>
<td>The <strong>forward to notify client</strong> workflow activity connects a phone call to a Notify WebRTC client.</td>
</tr>
<tr>
<td>Call workflow activity</td>
<td>The <strong>Call</strong> activity makes outbound phone calls using a Notify workflow. This workflow activity can be added to any table.</td>
</tr>
<tr>
<td>Join conference call workflow activity</td>
<td>The <strong>Join Conference Call</strong> activity connects an incoming or outgoing call to a Notify conference call.</td>
</tr>
<tr>
<td>Send SMS workflow activity</td>
<td>The <strong>send SMS</strong> workflow activity to send short text messages using Notify to users’ phones. This workflow activity can be added to any table.</td>
</tr>
<tr>
<td>Queue workflow activity</td>
<td>The <strong>Queue</strong> activity places an active Notify call in a queue.</td>
</tr>
</tbody>
</table>

### Notification activities

Notification workflow activities notify users of events that occur during the workflow.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Event workflow activity</td>
<td>The <strong>Create Event</strong> activity adds an event to the event queue, but does not immediately fire the event.</td>
</tr>
<tr>
<td>Notification workflow activity</td>
<td>The <strong>Notification</strong> activity sends an email or SMS message to specified users or groups.</td>
</tr>
</tbody>
</table>
Subflow activities

Subflow activities run and manage workflows from a parent workflow.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parallel Flow Launcher workflow activity</td>
<td>The <strong>Parallel Flow Launcher</strong> activity launches multiple subflows in parallel.</td>
</tr>
</tbody>
</table>
Utility activities

Utility activities provide controls over the path of the workflow, and other useful tools.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Branch workflow activity</td>
<td>The <strong>Branch</strong> activity splits the workflow into multiple transition paths from a single activity.</td>
</tr>
<tr>
<td>Join workflow activity</td>
<td>The <strong>Join</strong> activity unites multiple execution paths into one transition.</td>
</tr>
<tr>
<td>Lock workflow activity</td>
<td>The <strong>Lock</strong> activity prevents other instances of this workflow from continuing past this activity until the lock is released.</td>
</tr>
<tr>
<td>Log Message workflow activity</td>
<td>The <strong>Log Message</strong> activity writes a message to the workflow log.</td>
</tr>
<tr>
<td>Log Trace Message workflow activity</td>
<td>The <strong>Log Trace Message</strong> activity writes a trace message to the workflow log.</td>
</tr>
<tr>
<td>REST Message legacy workflow activity</td>
<td>The legacy <strong>REST Message</strong> activity enables an administrator to override the REST endpoint or supply the variables configured in the REST Message module.</td>
</tr>
<tr>
<td>Return Value workflow activity</td>
<td>The <strong>Return Value</strong> activity returns a value to a parent workflow, when run from a subflow.</td>
</tr>
<tr>
<td>Run Script workflow activity</td>
<td>The <strong>Run Script</strong> activity runs the specified script in the scope of the workflow version.</td>
</tr>
<tr>
<td>Set Values workflow activity</td>
<td>The <strong>Set Values</strong> activity sets values on the current record when the workflow quiesces or ends.</td>
</tr>
<tr>
<td>SOAP Message legacy workflow activity</td>
<td>The legacy <strong>SOAP Message</strong> activity uses SOAP messages defined in the System Web Services plugin and can call the messages using a MID Server.</td>
</tr>
<tr>
<td>Turnstile workflow activity</td>
<td>The <strong>Turnstile</strong> activity limits how many times a workflow can pass through the same point.</td>
</tr>
<tr>
<td>Unlock workflow activity</td>
<td>The <strong>Unlock</strong> activity releases a lock that was previously placed by the <strong>Lock</strong> activity.</td>
</tr>
</tbody>
</table>

Activities provided with Orchestration

The following activities are included with Orchestration.

- Active Directory activity pack
- Orchestration activities
- PowerShell activities
- Puppet activities

Templates provided for creating custom activities

If Orchestration is active on your system, users with the proper roles can create custom activities using the ServiceNow Orchestration activity designer. For information about the templates Orchestration provides for
creating custom activities that you can upload to the ServiceNow Store, see Orchestration custom activity templates

**Approval and rollback workflow activities**

Approval and rollback activities generate and manage approvals. Approval and rollback activities are not available in some workflows.

- With two exceptions, approval and rollback activities are only available when the workflow runs on a table that extends Task. The exceptions are the Approval - User and Approval Action activities, which are available globally.
- Approval and rollback activities are available only if approval engines are turned off for the table on which the workflow runs. If approval engines are enabled for the table, approval activities appear greyed out and cannot be selected. To learn more about how workflow and approval engines interact, read Approval workflow activities and approval engines.

**Approval Action workflow activity**

The Approval Action activity performs an approval action on the current task. Use this activity to mark the current task record as approved or rejected.

**Note:** When an Approval Action activity is used to mark a task approved, the activity marks all pending approvals as No Longer Required. This activity behaves differently from Set Values or Run Script when used to set the Approval field's value.

**Results**

The result value of the activity is the final approval disposition selected by the approver. The result value can be Approved or Rejected. A workflow designer can assign a result value using the activity.result variable from within a script field of the activity.

**Input variables**

Input variables determine the initial behavior of the activity.

**Approval Action activity input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>The action to perform on the task. Options are:</td>
</tr>
<tr>
<td></td>
<td>• Mark task approved</td>
</tr>
<tr>
<td></td>
<td>• Mark task rejected</td>
</tr>
<tr>
<td></td>
<td>• Mark task requested</td>
</tr>
<tr>
<td></td>
<td>• Disregard pending approvals: the system sets approval records to no longer required and marks the activity as approved.</td>
</tr>
</tbody>
</table>

**Conditions**

The conditions determine which transition runs after this activity.
Note: Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.

### Approval Action activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always</td>
<td>The event or condition that causes the approval to move to the next workflow step.</td>
</tr>
<tr>
<td>Error</td>
<td>The event or condition that generates an error.</td>
</tr>
<tr>
<td>Skipped</td>
<td>The event or condition that allows a skipped approval.</td>
</tr>
</tbody>
</table>

### States

The activity state tells the workflow engine what to do with the activity.

### Approval Action activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the <code>execute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

### Approval Coordinator workflow activity

The Approval Coordinator activity creates an approval whose outcome depends on the outcome of one or more child activities, including one or more Approval - User, Approval - Group, and/or Manual Approval activities.

Note: This activity is only available when the workflow runs on a table that extends Task.

To create an Approval Coordinator activity, first drag the activity onto the workflow canvas, causing the activity form to display. On the activity form, fill in the appropriate fields, then click Submit.

After you click Submit, the activity appears on the workflow canvas. From there, specify the child activities by clicking the links that appear on the body of the activity.

When the Approval Coordinator activity completes, all pending approvals that were created by any of the Approval Coordinator approval activities are immediately set to No Longer Required. If a single user is called as an approver twice by the same workflow, such as when a single user is both a product approver and an executive approver, any approvals for that user after the first are skipped.
Results

The result value of the Approval Coordinator activity depends on the approval actions taken by the approvers and the approval conditions specified in the Wait for field. Possible result values are:

- Approved
- Rejected
- Deleted
- Cancelled

Input variables

Input variables determine the initial behavior of the activity.

Approval Coordinator activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait for</td>
<td>Indicate what to wait for to indicate that the approval activity is approved or rejected. Options are:</td>
</tr>
<tr>
<td></td>
<td>• Any child activity to be approved: Any child activity (User, Group, or Manual Approval) that completes with a result of approved causes the Approval Coordinator activity to complete with a result of approved.</td>
</tr>
<tr>
<td></td>
<td>• All child activities to be approved: All child activities of the Approval Coordinator activity must complete with a result of approved to cause the Approval Coordinator activity to complete with a result of approved.</td>
</tr>
<tr>
<td></td>
<td>• The first approval or rejection from any child activity: The first child activity that completes with a result of approved or rejected causes the Approval Coordinator activity to complete with the same result.</td>
</tr>
<tr>
<td></td>
<td>• Condition based on script: Call a script to determine how to manage an approval or rejection.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| When a rejection occurs | Specify what the coordinator should do when it sees a rejection from any one of the child activities. Options are:  
• **Reject the approval:** Immediately complete the **Approval Coordinator** activity with a result of **rejected**.  
• **Wait for other responses before deciding:** Wait until we get other responses from other child activities before making an approval or rejection decision.  
This allows users to change their minds until a decision is made.  
In addition, if **Wait for** is set to **Any child activity to approve** then a single child activity completion with a result of **approved** will cause the **Approval Coordinator** activity to complete with a result of **approved** even if other child activities have completed with a result of **rejected**. |
| Approval script | If the **Wait for** variable is set to **Condition based on script** this script is called to determine how to handle an approval or rejection. The script needs to set the variable **answer** to , approved or rejected to indicate the overall approval status for this approval. When called, the following variable is available to the script:  
```plaintext
counts.total = total number of child approval activities that are part of this approval  
counts.approved = # of child approval activities that approved so far  
counts.rejected = # of child approval activities that rejected so far  
counts.requested = # of child approval activities that are pending approval
``` |

**Conditions**

The conditions determine which transition runs after this activity.

**Note:** Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.
Approval Coordinator activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>The users from the groups have approved the request based on the Wait for rules.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The users from the groups have rejected the request based on the Wait for rules.</td>
</tr>
</tbody>
</table>

States

The activity state tells the workflow engine what to do with the activity.

Approval Coordinator activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the <code>execute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Approval - Group workflow activity

The Approval - Group activity creates approval records for each member of a specified group.

**Note:** This activity is only available when the workflow runs on a table that extends Task.

The group approval is approved or rejected based on the user approvals, according to the logic specified in the Wait For field.

Results

The workflow designer can assign a result value using `activity.result` from within a script field of the activity. By default, the result value is the final approval disposition. This disposition depends on the approval actions taken by the approvers and the approval conditions specified in the Wait for or When Anyone Rejects fields. Possible result values are:

- Approved
- Rejected
- Deleted
- Cancelled
## Input variables

Input variables determine the initial behavior of the activity.

### Approval - Group activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval - Group When</td>
<td>Specify when this activity generates a group approval record.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions which, if met, cause the group approval to be generated. If the conditions are not met, the approval is skipped.</td>
</tr>
<tr>
<td>Approval - Group Approvers</td>
<td>Specify the groups whose approval will be requested.</td>
</tr>
<tr>
<td>Groups</td>
<td>The groups whose approval will be requested.</td>
</tr>
<tr>
<td></td>
<td>To edit this field, click the lock icon. To select specific groups by name, use the lookup list. To select groups from field values on the current record at runtime, click the tree icon.</td>
</tr>
<tr>
<td></td>
<td>Each member of the group will be assigned an individual approval record.</td>
</tr>
<tr>
<td></td>
<td>If no group is selected, the activity automatically sets the approval to <strong>Approved</strong>.</td>
</tr>
</tbody>
</table>

### Approval - Group Condition

Specify how the activity decides to approve or reject the group approval, based on the responses from individual members of the group.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Wait for</strong></td>
<td>A choice between different approval logics to determine which individual approvals or rejections result in approval or rejection of the activity's approval. Options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>An approval from each group</strong>: Any user from each group can approve and the first approval from each group causes the activity to complete with a result of <em>approved</em> (see below for how a rejection is handled).</td>
</tr>
<tr>
<td></td>
<td>• <strong>An approval from any group</strong>: Any user from any group can approve and the first approval from any group causes the activity to complete with a result of <em>approved</em>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>An approval from everyone from all groups</strong>: All users from all groups must approve to cause the activity to complete with a result of <em>approved</em> (see below for how a rejection is handled).</td>
</tr>
<tr>
<td></td>
<td>• <strong>First response from each group</strong>: The first approval or rejection from any user in each group is used to indicate the state of the group approval (see below for how a rejection is handled).</td>
</tr>
<tr>
<td></td>
<td>Indicate what happens when any user rejects their approval request. Options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reject the approval</strong>: Immediately complete the activity with a result of <em>rejected</em>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>First response from any group</strong>: The first approval or rejection from any user in any group causes the activity to complete with a result of <em>approved</em> or <em>rejected</em>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Condition based on script</strong>: Each time a user approves or rejects, the <em>Approval script</em> is called to determine if the activity should complete.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Approval script</td>
<td>If the <strong>Wait for</strong> variable is set to <strong>Condition based on script</strong> this script is called to determine how to handle an approval or rejection. The script needs to set the variable <strong>answer</strong> to approved or rejected to indicate the overall status for this approval. This script is responsible for setting the approval state for each group that is part of this approval activity before returning the overall approval state for all of the groups. When called, the following variables are available to the script for all the groups that are part of this approval activity:</td>
</tr>
<tr>
<td></td>
<td>counts.total = total number of groups that are part of this approval counts.approved = # of groups that approved so far counts.rejected = # of groups that rejected so far counts.requested = # of groups that are pending approval counts.not_requested = # of groups that are not pending approval counts.not_required = # of groups that approval is not required And for each group:</td>
</tr>
<tr>
<td></td>
<td>groups[group_id].total = total number of users that are part of this group's approval groups[group_id].approved = # of users that approved so far groups[group_id].rejected = # of users that rejected so far groups[group_id].requested = # of users that are pending approval groups[group_id].not_requested = # of users that are not pending approval groups[group_id].not_required = # of users that approval is not required groups[group_id].approvalIDs[state] = array of user ids that are at the specified approval state</td>
</tr>
</tbody>
</table>
### When anyone rejects

A choice between different approval logics to determine which individual rejections result in rejection of the activity's approval. Options are:

- **Reject the approval**: Immediately complete the activity with a result of rejected.
- **Wait for other responses before deciding**: Wait until we get other responses before making an approval or rejection decision. This allows users to change their mind until a decision is made.

**Note:** If **Wait for** is set to **Anyone to approve**, then a single approval causes the activity to complete with a result of approved, even if one or more users reject.

<table>
<thead>
<tr>
<th>Approval - Group Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify how workflow calculates the approval record's expected start date and due date. Once you've made a selection for 'Due date based on', and 'Schedule based on', the appropriate fields will display.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| When anyone rejects | A choice between different approval logics to determine which individual rejections result in rejection of the activity's approval. Options are:  
- **Reject the approval**: Immediately complete the activity with a result of rejected.  
- **Wait for other responses before deciding**: Wait until we get other responses before making an approval or rejection decision. This allows users to change their mind until a decision is made.  
  
  **Note:** If **Wait for** is set to **Anyone to approve**, then a single approval causes the activity to complete with a result of approved, even if one or more users reject. |

| Due date based on | Select how workflow determines the task's duration, due date, and schedule.  
- **A user specified duration**: The duration is based on a user specified value.  
- **A relative duration**: The duration is calculated from a relative duration (such as End of Next Business Day).  
- **A date/time or duration field**: The duration is based on the value of a field on the current record.  
- **Script**: The duration is returned by a script. |

<table>
<thead>
<tr>
<th>Duration</th>
<th>Only appears when <strong>Due date based on</strong> is set to <strong>A user specified duration</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative duration</td>
<td>Only appears when <strong>Due date based on</strong> is set to <strong>A relative duration</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Due date field</th>
<th>Only appears when <strong>Due date based on</strong> is set to <strong>A date/time or duration field</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Due date script</td>
<td>Only appears when <strong>Due date based on</strong> is set to <strong>Script</strong></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Schedule based on</strong></td>
<td>The basic schedule the timer uses to count working hours. If a schedule is specified, the duration will only be considered for times that are specified on the schedule. For example, if the duration is 2 hours and the workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends at 9:00am the next day. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>This workflow's schedule</strong>: The schedule uses workflow context date, time, and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A specific schedule</strong>: The schedule uses a pre-defined <strong>Schedule</strong> and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A schedule field</strong>: The schedule uses a value from a table and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td>Schedule</td>
<td>The predefined <strong>Schedule</strong> from a list.</td>
</tr>
<tr>
<td>Only appears when <strong>Schedule based on</strong> is set to</td>
<td></td>
</tr>
<tr>
<td><strong>A specific schedule</strong></td>
<td></td>
</tr>
<tr>
<td>Schedule field</td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
<tr>
<td>Only appears when <strong>Schedule based on</strong> is set to</td>
<td></td>
</tr>
<tr>
<td><strong>A schedule field</strong></td>
<td></td>
</tr>
<tr>
<td>Time zone based on</td>
<td>The time zone for calculating the duration. The time zone may be based on:</td>
</tr>
<tr>
<td></td>
<td>• <strong>No time zone</strong>: Default. Worksheet uses the GMT time zone.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A specific time zone</strong>: A specific <strong>Time zone</strong> that you choose from a choice list.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A time zone field</strong>: A <strong>Time zone field</strong> to track time duration from a field on the form.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Select the time zone you want from the choice list.</td>
</tr>
<tr>
<td>Only appears when <strong>Time zone based on</strong> is set to</td>
<td></td>
</tr>
<tr>
<td><strong>A specific time zone</strong></td>
<td></td>
</tr>
<tr>
<td>Time zone field</td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
<tr>
<td>Only appears when <strong>Time zone based on</strong> is set to</td>
<td></td>
</tr>
<tr>
<td><strong>A time zone field</strong></td>
<td></td>
</tr>
<tr>
<td>Approval - Advanced</td>
<td>If desired, write a script for determining additional users to request approvals from.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to write a script for determining additional users to request approvals from. Use the <strong>Additional groups script</strong> to customize group approvals.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Additional groups script| If the **Advanced** check box is selected, this script is called to determine any additional group approvals to be created. The script needs to set the variable `answer` to a comma-separated list of group ids or an array of group ids to add as approver groups. For example:  
  ```javascript
  var answer = [];
  answer.push('id1');
  answer.push('id2');
  ``` |

### Conditions

The following conditions determine which transition runs after this activity.

**Note:** Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.

#### Approval - Group activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>The users from the groups have approved the request based on the <strong>Wait for</strong> rules.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The users from the groups have rejected the request based on the <strong>Wait for</strong> rules.</td>
</tr>
<tr>
<td>Error</td>
<td>The event or condition that generates an error.</td>
</tr>
<tr>
<td>Skipped</td>
<td>The event or condition that allows a skipped approval.</td>
</tr>
</tbody>
</table>

### States

The activity state tells the workflow engine what to do with the activity.

#### Approval - Group activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the <code>execute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

**Approval - User workflow activity**

The **Approval - User** activity creates one or more individual user approvals.

**Results**

The result value is the final approval disposition. This disposition depends on the approval actions take by the approvers and the approval conditions specified in the **Wait for** or **When Anyone Rejects** fields. Possible result values are:

- Approved
- Rejected
- Deleted
- Cancelled

**Input variables**

**Approval - User activity input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval - User When</td>
<td>Specify when this activity generates a user approval record.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions which, if met, cause the individual approval to be generated. If the conditions are not met, the approval is skipped.</td>
</tr>
<tr>
<td>Approval - User Approvers</td>
<td>Specify the users whose approval will be requested.</td>
</tr>
<tr>
<td>Users</td>
<td>The users for the approval. Use the tree icon to select user reference fields from the current record to create approvals, such as ${assigned_to}. If no user is selected, the activity automatically sets the approval to <strong>Approved</strong>.</td>
</tr>
</tbody>
</table>

**Note:** Workflow only manages approval records generated by the Approval User activity. After starting the workflow, newly added approvals do not affect the workflow context.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Groups</td>
<td>Groups whose members should also receive approvals. Note that this is different than the Approval - Group activity, which creates a group approval in addition to the individual approvals. The tree icon can be used to select group reference fields from the current record to create approvals, such as <code>${assignment_group}</code>.</td>
</tr>
</tbody>
</table>

#### Approval - User Condition

Specify how the activity decides to approve or reject the approval, based on the responses from individual approvers.

<table>
<thead>
<tr>
<th>Wait for</th>
<th>A choice between different approval logics to determine which individual approvals result in approval of the activity’s approval. Options are:</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Anyone to approve</td>
<td>• <strong>Anyone to approve</strong>: Any user can approve and the first approval causes the activity to complete with a result of <strong>approved</strong>.</td>
</tr>
<tr>
<td>- Everyone to approve</td>
<td>• <strong>Everyone to approve</strong>: All users must approve (see below for how a rejection is handled).</td>
</tr>
<tr>
<td>- First response from anyone</td>
<td>• <strong>First response from anyone</strong>: The first approval or rejection from any user causes the activity to complete.</td>
</tr>
<tr>
<td>- Condition based on script</td>
<td>• <strong>Condition based on script</strong>: Each time a user approves or rejects, the Approval script is called to determine if the activity should complete.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>When anyone rejects</th>
<th>A choice between different approval logics to determine which individual rejections result in rejection of the activity's approval. Options are:</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Reject the approval</td>
<td>• <strong>Reject the approval</strong>: Immediately complete the activity with a result of <strong>rejected</strong>.</td>
</tr>
<tr>
<td>- Wait for other responses before deciding</td>
<td>• <strong>Wait for other responses before deciding</strong>: Wait until we get other responses before making an approval or rejection decision. This allows users to change their mind until a decision is made.</td>
</tr>
</tbody>
</table>

**Note**: Note that if **Wait for** is set to **Anyone to approve** then a single approval will cause the activity to complete with a result of **approved** even if one or more users reject.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Column</td>
<td>A string field for the name of the approval field on the table the workflow is running on. The default value is approval, which is the field on the Task table.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Use the field's name, not its label.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If using any custom approval column fields and approval column journals, use Set Value activities in the workflow to set the custom Approval column fields.</td>
</tr>
<tr>
<td>Approval Journal Column</td>
<td></td>
</tr>
<tr>
<td>Approval Script</td>
<td>If the <strong>Wait for</strong> variable is set to <strong>Condition based on script</strong> this script is called to determine how to handle an approval or rejection. The script needs to set the variable <strong>answer</strong> to approved or rejected to indicate the approval status for this approval. When called, the following information is available:</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>counts.total = total number of users that are part of this approval</td>
</tr>
<tr>
<td></td>
<td>counts.approved = # of users that approved so far</td>
</tr>
<tr>
<td></td>
<td>counts.rejected = # of users that rejected so far</td>
</tr>
<tr>
<td></td>
<td>counts.requested = # of users that are pending approval</td>
</tr>
<tr>
<td></td>
<td>counts.not_requested = # of users that are not pending approval</td>
</tr>
<tr>
<td></td>
<td>counts.not_required = # of users that approval is not required</td>
</tr>
<tr>
<td>Approval - User Schedule</td>
<td>Specify how workflow calculates the approval record's expected start date and due date. Once you've made a selection for 'Due date based on', and 'Schedule based on', the appropriate fields will display.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Due date based on</td>
<td>Select how workflow determines the task's duration, due date, and schedule.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A user specified duration</strong>: The duration is based on a user specified value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A relative duration</strong>: The duration is calculated from a relative duration (such as End of Next Business Day).</td>
</tr>
<tr>
<td></td>
<td>• <strong>A date/time or duration field</strong>: The duration is based on the value of a field on the current record.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Script</strong>: The duration is returned by a script.</td>
</tr>
<tr>
<td>Duration</td>
<td>The specific number of days and hours.</td>
</tr>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to A user specified duration</td>
<td></td>
</tr>
<tr>
<td>Relative duration</td>
<td>The general number and length of business days.</td>
</tr>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to A relative duration</td>
<td></td>
</tr>
<tr>
<td>Due date field</td>
<td>The date/time or duration field.</td>
</tr>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to A date/time or duration field</td>
<td></td>
</tr>
<tr>
<td>Due date script</td>
<td>The script that sets 'answer' to the number of seconds for the duration.</td>
</tr>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to Script</td>
<td></td>
</tr>
<tr>
<td>Schedule based on</td>
<td>The basic schedule the timer uses to count working hours. If a schedule is specified, the duration will only be considered for times that are specified on the schedule. For example, if the duration is 2 hours and the workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends at 9:00am the next day. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>This workflow's schedule</strong>: The schedule uses workflow context date, time, and an optional Time zone based on value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A specific schedule</strong>: The schedule uses a pre-defined Schedule and an optional Time zone based on value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A schedule field</strong>: The schedule uses a value from a table and an optional Time zone based on value.</td>
</tr>
<tr>
<td>Schedule</td>
<td>The predefined Schedule from a list.</td>
</tr>
<tr>
<td>Only appears when <strong>Schedule based on</strong> is set to A specific schedule</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Schedule field</td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
<tr>
<td>Only appears when <strong>Schedule based on</strong> is set to <strong>A schedule field.</strong></td>
<td></td>
</tr>
<tr>
<td>Time zone based on</td>
<td>The time zone for calculating the duration. The time zone may be based on:</td>
</tr>
<tr>
<td></td>
<td>• <strong>No time zone</strong>: Default. Workflow uses the GMT time zone.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A specific time zone</strong>: A specific <strong>Time zone</strong> that you choose from a choice list.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A time zone field</strong>: A <strong>Time zone field</strong> to track time duration from a field on the form.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Select the time zone you want from the choice list.</td>
</tr>
<tr>
<td>Only appears when <strong>Time zone based on</strong> is set to <strong>A specific time zone</strong>.</td>
<td></td>
</tr>
<tr>
<td>Time zone field</td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
<tr>
<td>Only appears when <strong>Time zone based on</strong> is set to <strong>A time zone field.</strong></td>
<td></td>
</tr>
<tr>
<td>Approval - Advanced</td>
<td>If desired, write a script for determining additional users to request approvals from.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to write a script for determining additional users to request approvals from.</td>
</tr>
<tr>
<td>Additional approvers script</td>
<td>If the <strong>Advanced</strong> check box is selected, this script is called to determine any additional user approvals to be created. The script needs to set the variable <strong>answer</strong> to a comma-separated list of user ids and group ids or an array of user and group ids to add as approvers. For example:</td>
</tr>
<tr>
<td></td>
<td>```js</td>
</tr>
<tr>
<td></td>
<td>answer = [];</td>
</tr>
<tr>
<td></td>
<td>answer.push('id1');</td>
</tr>
<tr>
<td></td>
<td>answer.push('id2');</td>
</tr>
<tr>
<td>Conditions</td>
<td>The following conditions determine which transition runs after this activity.</td>
</tr>
</tbody>
</table>

**Note:** Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.
Approval - User activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>The users approved the request based on the <strong>Wait for</strong> rules.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The users rejected the request based on the <strong>Wait for</strong> rules.</td>
</tr>
<tr>
<td>Error</td>
<td>The event or condition that generates an error.</td>
</tr>
<tr>
<td>Skipped</td>
<td>The event or condition that allows a skipped approval.</td>
</tr>
</tbody>
</table>

States

The activity state tells the workflow engine what to do with the activity.

Approval - User activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the <code>execute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

**Generate workflow activity**

The `Generate` activity immediately creates task or approval records from any task or approval activities placed after the `Generate` activity in the workflow path. These pre-generated tasks and approvals start when the task and approval activities are reached during flow execution. This allows a task to have a set of associated pre-generated sequential tasks or approvals, but still require them to be completed in order.

**Note:** This activity is only available when the workflow runs on a table that extends Task.

By default, the workflow does not create any tasks or approvals until it reaches them in the workflow.

The `Generate` activity follows all transitions through the workflow to each activity. For each activity:
• If it is a task activity, creates the task and sets:
  • The State to Pending
  • The Expected Start Date
  • The Due Date

  **Note:** Task activities run as the user whose actions complete the task the workflow was waiting for and advances the workflow.

• If it is an approval activity, creates the approvals and sets:
  • The approval State to Not Requested
  • The Expected Start Date
  • The Due Date

  **Note:** Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.

Expected start dates and due dates are calculated based on the **Expected Duration** of all of the tasks and approvals between the Generate activity and the activity being updated. In the case of a branched path (between a Branch and Join activity), the longer duration will be used for any post-branch activities.

The Generate activity can be used more than once, and any tasks or approvals will be refreshed with updated information. This is useful in situations where the list of approvers or other important information is still editable while the workflow is in process and it may be necessary to update or correct the generated approvals or tasks.

To exclude a set of activities from the Generate activity, select the **Skip during generate** check box on any condition and its transitions will not be followed during the generate process. By default, the following conditions have the **Skip during generate** check box selected:

• Rejected (for any of the approval activities)
• No condition of If activity
• Continue condition of Turnstile activity
• Incomplete condition of Join activity

**Input variables**

Input variables determine the initial behavior of the activity.

**Generate activity input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate approvals</td>
<td>If selected, approvals are created when running the Generate activity. If cleared, the approvals are used to compute their estimated duration, but no approvals are created.</td>
</tr>
<tr>
<td>Generate tasks</td>
<td>If selected, tasks are created when running the Generate activity. If cleared, the tasks are used to compute their estimated duration, but no tasks are created.</td>
</tr>
</tbody>
</table>
States

The activity state tells the workflow engine what to do with the activity.

**Generate activity states**

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The activity is executing.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
</tbody>
</table>

**Example**

In this example, the following approvals are generated:

- Approval-2
• Approval-3

Approval-4 is skipped since the Rejected condition of Approval-3 has Skip during generate selected. Here is an example of using the Generate activity that describes the expected start and due dates:

![Diagram]

Generate workflow start and due date

In this example, if the Generate activity is run on Jan 1, 2016, the following expected start dates and due dates would be set for the generated tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Expected Start Date</th>
<th>Reason</th>
<th>Due Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task 2 (1 day)</td>
<td>Jan. 2, 2016</td>
<td>Task 1 is 1 day</td>
<td>Jan. 3, 2016</td>
</tr>
<tr>
<td>Task 4 (1 day)</td>
<td>Jan. 3, 2016</td>
<td>Task 3 is 2 days</td>
<td>Jan. 4, 2016</td>
</tr>
<tr>
<td>Task 5 (1 day)</td>
<td>Jan. 4, 2016</td>
<td>Task 4 ends the latest before the Join</td>
<td>Jan. 5, 2016</td>
</tr>
</tbody>
</table>

Notice that Task 5 starts on Jan. 4, 2016 since the longest path (based on due dates) to the Join is Task 3/Task 4.

Manual Approvals workflow activity

The Manual Approvals activity watches and manages any approvals that users add manually outside of the workflow process. This activity only selects approvals that are in the Not requested state.

Note: This activity is only available when the workflow runs on a table that extends Task.

If there are no pending manual approvals when this activity executes, the activity immediately completes with a result of approved. This activity does not create approval records. Use this activity to pause the workflow when a user adds a manual approval to a record with an associated workflow, and it is in the Not requested state. The workflow waits for the approval to be closed before proceeding.
Results

The workflow designer can assign a result value using `activity.result` from within a script field of the activity. By default, the result value of the activity is the final approval disposition determined by the approval actions take by the approvers. Possible result values are:

- Approved
- Rejected
- Deleted
- Cancelled
- Error

Input variables

Input variables determine the initial behavior of the activity.

### Manual Approvals activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait for</td>
<td>Indicate what to wait for to indicate that the approval activity is approved or rejected. Options are:</td>
</tr>
<tr>
<td></td>
<td>- Any manual user or group approval: Any user can approve and the first approval causes the activity to complete with a result of <strong>approved</strong>.</td>
</tr>
<tr>
<td></td>
<td>- All manual user or group approvals: All users must approve (see below for how a rejection is handled).</td>
</tr>
<tr>
<td></td>
<td>- The first response from any manual approval: The first approval or rejection from any user causes the activity to complete.</td>
</tr>
<tr>
<td>When anyone rejects</td>
<td>Indicate what happens when any user rejects their approval request. Options are:</td>
</tr>
<tr>
<td></td>
<td>- Reject the approval: Immediately complete the activity with a result of <strong>rejected</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Wait for other responses before deciding: Wait until we get other responses before making an approval or rejection decision. This allows users to change their mind until a decision is made.</td>
</tr>
<tr>
<td></td>
<td>In addition, if <strong>Wait for</strong> is set to <strong>Anyone to approve</strong> then a single approval will cause the activity to complete with a result of <strong>approved</strong> even if one or more users reject.</td>
</tr>
</tbody>
</table>
**Note:** Approval activities run as the user whose actions match the approve or reject conditions the workflow was waiting for and advances the workflow.

### Manual Approvals activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>The users from the groups have approved the request based on the <em>Wait for</em> rules.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The users from the groups have rejected the request based on the <em>Wait for</em> rules.</td>
</tr>
</tbody>
</table>

### States

The activity state tells the workflow engine what to do with the activity.

#### Manual Approvals activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the <code>execute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

**Rollback To workflow activity**

The *Rollback To* activity transitions directly to the activity specified by the outgoing transition line arrow.

**Note:** This activity is only available when the workflow runs on a table that extends Task.

*Rollback To* determines which activities to reset based on the actual workflow sequence (transition line attachments) of activities between itself and the transitioned to activity, not the execution order. *Rollback To* then marks all the approvals that have transitioned between the rollback and the transitioned to activity as *Not Yet Requested* and the tasks as either *Open* or *Pending*.

Use the *Rollback To* activity for all workflows in which multiple rollbacks are required. *Rollback To* has no variables.

### Conditions

The conditions determine which transition runs after this activity.
Rollback To activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always</td>
<td>The event or condition that causes the approval to revert to the previous workflow step.</td>
</tr>
<tr>
<td>Error</td>
<td>The event or condition that generates an error.</td>
</tr>
<tr>
<td>Skipped</td>
<td>The event or condition that allows a skipped approval.</td>
</tr>
</tbody>
</table>

States

The activity state tells the workflow engine what to do with the activity.

Rollback To activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the <code>execute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Rollback To behavior

The Rollback To activity transitions directly to the activity specified by the transition line arrow.

Use the Rollback To activity for all workflows that use multiple or nested rollbacks. Rollback To resets the targeted task (the direct transition) to Open. All tasks that have executed between the Rollback To activity and the targeted task (rolled back task) are set to Pending.

(0) Begin
(1) Log Message
(2) Task 1
(3) Task 3
(4) Task 2
(5) Timer
(6) Approval 1
(7) Roll back to first task
(8) Task 1
(9) Task 2
(10) Approval 1
(11) Log approval
(12) Join
(14) Send email
(15) End

Rollback to workflow

Transition history

The state of (3) Task 3 does not change, since this activity does not directly transition from the rollback target activity. To see what activities were rolled back, select the Workflow Transition History related list and look at the Rolled back column.

The Rollback To activity (7) updates the following activities:

(8) Task 1: reset to Open
(9) Task 2: reset to Pending
(10) Approval 1: reset to **Not Yet Requested**

Rollback To workflow transition

Rollback To activity

When conditions in a workflow trigger a Rollback To activity, the workflow moves processing backward to a specified activity in the workflow and resets certain activities that have already executed back to their original state. This is useful when handling an unexpected failure or as part of a programmed logical flow.

When an activity is reset during a workflow rollback, the following happens:

- Approvals are reset to **Not Requested**.
- Tasks are reset to either **Open** or **Pending**. A rollback workflow path cannot create new tasks.

Activities that perform external system operations, such as deleting a file or sending an email, are not rolled back. Only approval and task activity states are reset.

A workflow can contain a single rollback, multiple rollbacks, or nested rollbacks in more complex workflows. The Rollback To activity resets activities based on the actual workflow sequence (transition
Condition Workflow activities

Condition activities provide conditional branching and logical operation functionality for workflows.

If workflow activity

The If activity checks a condition or script to determine if a Yes or No transition should be taken.

If the workflow creator specifies both the Condition and the Advanced script, both must evaluate successfully for activity to take the Yes transition.

Results

The workflow designer can assign a result value using activity.result from within the Script field on the activity record. By default, the result value of the activity is the final result of the condition or script specified. Possible result values are:

- Yes
- No

Input variables

The following variables determine the behavior of the activity.

Note: Condition activities run as the user whose actions match the conditions the workflow was waiting for and advances the workflow.

If activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>If specified and the current record matches the condition, the Yes transition is taken.</td>
</tr>
<tr>
<td>Advanced and Script</td>
<td>To specify a script, select the Advanced check box. You may then enter a script that is evaluated. If your script sets the variable answer to yes, then the Yes transition is taken. Otherwise, the No transition is taken.</td>
</tr>
</tbody>
</table>

Conditions

The following conditions determine which transition comes after the activity.

If activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Taken when the condition, if specified, matches and the Advanced script, if specified, returns yes.</td>
</tr>
</tbody>
</table>
### States

The activity state tells the workflow engine what to do with the activity.

#### If activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <code>onExecute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

**Switch workflow activity**

The **Switch** activity checks if the value of a passed field or variable is equivalent to one of several case values.

The switch activity behavior is similar to a switch statement in Java.

When creating a switch activity, select a **Variable** or **Field** to check against activity conditions for a matching field value. When the value passed in this variable or field matches the value defined in the **Condition** field of the activity condition, the workflow progresses through that activity condition.

**Note:** Condition activities run as the user whose actions match the conditions the workflow was waiting for and advances the workflow.

### Results

The variable or field selected in the **Variable** or **Field** activity variable determines the possible result values.

### Input variables

The following variables determine the behavior of the activity.
Switch activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select <strong>Variable</strong> or <strong>Field</strong> as the type of value to check against available conditions. This selection sets the label and available options for the other field.</td>
</tr>
<tr>
<td>Variable or Field</td>
<td>Select the source of the value compared against the switch activity conditions. The field label and available options depend on the <strong>Type</strong> selection.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Variable</strong>: select any service catalog variable.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Field</strong>: select any field from the <strong>Table</strong> defined in the workflow properties.</td>
</tr>
</tbody>
</table>

States

The activity state tells the workflow engine what to do with the activity.

Switch activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <code>onExecute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Example

You can create a switch activity that sets different field values on an incident based on the Assignment group of the incident record.
Switch activity example

The Field selected is the incident Assigned to field.
Switch activity Field

If the value of the **Assigned to** field of the workflow-triggering incident is **Service Desk** or **Field Services**, the workflow populates values on the incident record before continuing. If the **Assigned to** value is **Hardware**, the workflow continues without populating any field values.

Condition type (Standard, Else, or Error) is used. For more information, see Manage workflow activity conditions.
**Hardware group condition**

*Wait for condition workflow activity*

The *Wait for condition* activity causes the workflow to wait at this activity until the current record matches the specified condition.

The workflow evaluates the *Wait for condition* activity each time the current record is updated. Use this activity to pause a workflow indefinitely until a particular criteria is met by a record update. To pause a workflow for a timed duration see [Timer workflow activities](https:// servicenow.com).

For workflow to consider the condition met, all conditions specified – whether in the builder or in a script – must be true.
**Note:** A **Wait for condition activity** should only be used to wait for an external event such as a record update, and not one from a workflow setting a value. If you have a workflow setting a value and want to wait for that same field to be seen as 'changed,' try inserting a one-second timer.

**Results**

The workflow designer can assign a result value using `activity.result` from within a script field of the activity. The activity transitions when the result value is true.

**Input variables**

The following variables determine the behavior of the activity.

**Note:** Condition activities run as the user whose actions match the conditions the workflow was waiting for and advances the workflow.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>The workflow is paused at this activity until this condition matches the current record.</td>
</tr>
<tr>
<td>Condition script</td>
<td>If specified, the workflow is paused at this activity until this script sets the <code>answer</code> variable to true.</td>
</tr>
</tbody>
</table>

**States**

The activity state tells the workflow engine what to do with the activity.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <code>onExecute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

**Wait for WF Event workflow activity**

The **Wait for WF Event** activity causes the workflow to wait at this activity until the specified event is fired.
Use this activity to wait for another activity to fire an event. Events from other activities are fired in a script using the workflow.fireEvent('eventName') API call.

**Results**

The workflow designer can assign a result value using `activity.result` from within a script field of the activity. This activity transitions when the specified event fires.

**Input variables**

The following variables determine the behavior of the activity.

**Note:** Condition activities run as the user whose actions match the conditions the workflow was waiting for and advances the workflow.

**Wait For WF Event activity input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait for Event</td>
<td>An event name to trigger the workflow.</td>
</tr>
</tbody>
</table>

**States**

The activity state tells the workflow engine what to do with the activity.

**Wait For WF Event activity states**

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <code>onExecute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

**Notify workflow activities**

Notify workflow activities manage calls and SMS messages in Notify.

All Notify workflows that manage a phone call must run on the `notify_call` table. Call-related Notify activities can be added only to workflows where the `Table` field value is `Notify Call [notify_call]`.

You can identify if an outbound call was answered by a human or by an answering machine from within a Notify workflow by evaluating the `current.is_human` variable, such as with an `If` workflow activity. This
variable is set by the telephony provider when an outbound call is answered. This variable is always true for inbound calls.

**Note:** Do not add a **Timer** activity between multiple Notify activities that interact with active phone calls.

**Important:** When creating a Notify workflow, set the workflow **If condition matches** field to **None**. Notify controls which workflow to run based on the configured number groups.

**Forward call workflow activity**
The **Forward Call** activity forwards a Notify call to an E.164-compliant phone number.

If the person receiving a forwarded call hangs up, the **forward call** activity completes and transitions to the next activity. Any further Notify activities in the workflow run for the caller only.

**Input variables**

Input variables determine the initial behavior of the activity.

| Input variables |
|-----------------|-----------------|
| **Variable**    | **Description**  |
| Phone number to call | Enter the phone number to forward the call to. |
| Timeout (in seconds) | Enter the amount of time to wait for the call to be answered before hanging up. |
| Record | Select this check box to record the conversation. |

**Conditions**

The conditions determine which transition comes after this activity. The **forward call** activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the phone number to call is invalid.

**Input workflow activity**
The **Input** activity creates a phone menu by presenting a list of options on a Notify call.

**Input Variables**

Input variables determine the initial behavior of the activity.

<p>| Input Variables |
|-----------------|-----------------|
| <strong>Variable</strong>    | <strong>Description</strong>  |
| Number of digits | Specify the maximum number of digits the caller can enter. A caller can enter fewer digits than the maximum and press the <strong>Finish key</strong> to complete the entry. |</p>
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finish key</td>
<td>Specify the key a caller can press on their phone when finished selecting a menu option.</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>Specify the amount of time to wait before closing the menu automatically when the caller does not select a menu option.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to build the phone menu, instead of using the activity conditions.</td>
</tr>
<tr>
<td>Script</td>
<td>Define the script to build the phone menu. The script must specify an <code>answer</code> variable as a JavaScript object with the following format:</td>
</tr>
</tbody>
</table>

```javascript
answer = {
  "1": {
    "play": "https://some_url.com/options/one.mp3",
    "myCustomData": "some data here"
  },
  "2": {
    "play": "https://some_url.com/options/two.mp3",
    "myCustomData": "some other data here"
  },
  "3": {
    "speak": "type 3 to speak to a representative",
    "language": "en-US",
    "myCustomData": "some more data here"
  }
};
```

The script may specify either a text-to-speech string and language code using the `speak` attribute or URL of the music to be played using the `play` attribute. You can also add optional attributes to store related information, such as `myCustomData` in the example above.

**Note:** The script object continues to support `say` attribute for backward compatibility.

### Conditions

The conditions determine the transition that comes after this activity.

The `input` activity does not specify any conditions by default. You must define conditions to build the phone menu. Each condition is one option on the phone menu. Notify reads the text from each condition **Name** to the caller, up to 100 characters per condition.
You can specify a language for each condition by prefixing the message with the language code, in the format `xx-XX:<Message>`. For example, add `fr-CA:` for Canadian French. Available languages are stored on the Notify Language [notify_language] table.

The condition that the activity transitions through depends on the digits entered by the caller. Set the condition `Condition` value to `parseInt(workflow.scratchpad.digits) == <expected digits>`. For example, to transition through a condition when the caller presses the number 3, set the `Condition` to `parseInt(workflow.scratchpad.digits) == 3`.

You can add an error condition to this activity. The activity transitions through the error condition if the advanced script returns an invalid value, or if the text to say for a condition is empty.

**Scratchpad Entries**

The activity uses the workflow scratchpad to write persistent values.

**Values written to scratchpad**

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>workflow.scratchpad.digits</td>
<td>The digits entered by the caller, as a string.</td>
</tr>
<tr>
<td>workflow.scratchpad.menu&lt;activity name&gt;</td>
<td>The entire <code>answer</code> variable, if using the advanced script option. You can access this menu from other activities after this activity successfully executes. For example, if the activity name is <code>choices</code>, you can access values from the menu using `var previousActivity = &quot;choices&quot;; var choicesMenu = workflow.scratchpad.menu[previousActivity]; var menuItem = choicesMenu[workflow.scratchpad.digits]; // Selects the menu item based on the caller's input. var selectedValue = menuItem.myCustomData; //get the custom data for the selected menu item.</td>
</tr>
</tbody>
</table>

**Hangup workflow activity**

The **Hangup** activity disconnects an active Notify phone call.

You can use the **hangup** activity to disconnect only calls that have been answered. Use the **reject** activity to disconnect calls that have not been answered.

**Play workflow activity**

The **Play** activity plays a sound file on a Notify call.

**Input Variables**

Input variables determine the initial behavior of the activity.
## Input Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Enter the URL of a sound file to play. If the URL is inaccessible, or if the audio file mime type is not supported by the telephony provider, the play activity is skipped.</td>
</tr>
<tr>
<td>Loop</td>
<td>Enter the number of times the sound file should play.</td>
</tr>
</tbody>
</table>

## Conditions

The conditions determine which transition comes after this activity. The play activity does not specify any conditions by default.

You can create an error condition to handle errors with the sound file. The activity transitions through the error condition if the specified sound file is not available, or has an unsupported mime type. Supported mime types are listed on the Notify Audio MIME Types [notify_mime_type] table.

**Record workflow activity**

The **Record** workflow activity records audio from a user on a Notify call.

**Note:** The Record workflow activity records call but not the conference call. To record the conference call, you can set the **Record** activity variable on the Join Conference Call workflow activity.

## Input Variables

Input variables determine the initial behavior of the activity.

### Input Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max duration (in seconds)</td>
<td>Enter the maximum duration, in seconds, allowed for a recording.</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>Enter the amount of time to wait before ending a recording automatically when the caller is silent.</td>
</tr>
<tr>
<td>Finish Key</td>
<td>Specify the key a caller can press on their phone to end the recording.</td>
</tr>
</tbody>
</table>

## Scratchpad Entries

The activity uses the workflow scratchpad to store persistent values.

The **record** activity adds the **recording** variable to the workflow scratchpad. This variable stores metadata about the recording, such as URI, ID, and duration. You can access the following values from this variable.
Values written to scratchpad

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>recording.recordingDuration</td>
<td>The duration of the recording, in seconds.</td>
</tr>
<tr>
<td>recording.from_number</td>
<td>The caller's phone number, including country code.</td>
</tr>
<tr>
<td>recording.notify_number</td>
<td>The Notify phone number used to respond to the call, including country code.</td>
</tr>
<tr>
<td>recording.recordingID</td>
<td>The ID used by the telephony provider to identify the recording.</td>
</tr>
<tr>
<td>recording.recordingURL</td>
<td>The URL from the telephony provider to access the recording.</td>
</tr>
</tbody>
</table>

Reject workflow
The **Reject** workflow activity rejects an incoming Notify call.

You can use the **reject** activity to disconnect only calls that have not yet been answered. Use the **hang up** activity to disconnect calls that have been answered.

Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reason</td>
<td>Select a reason for rejecting the call, such as <strong>busy</strong>.</td>
</tr>
</tbody>
</table>

Say workflow activity

The **say** workflow activity allows you to play a message, using text to speech, on a Notify call.

Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text to say</td>
<td>Specify the text to read.</td>
</tr>
<tr>
<td>Language</td>
<td>Select the language and locale to use when reading text.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to define the language and message, instead of using the <strong>Text to say</strong> and <strong>Language</strong> values.</td>
</tr>
</tbody>
</table>
### Forward to notify client workflow activity

The **forward to notify client** workflow activity connects a phone call to a Notify WebRTC client.

### Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Select the user to connect the call to.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to determine which client to connect to, instead of using the <strong>User</strong> variable.</td>
</tr>
<tr>
<td>Script</td>
<td>Define a script that controls which client to connect to. This script should return a GlideRecord for a single User [sys_user] record.</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>Enter the amount of time to wait for the call to be connected before hanging up.</td>
</tr>
<tr>
<td>Record</td>
<td>Select this check box to record the call.</td>
</tr>
</tbody>
</table>

### Conditions

The conditions determine which transition comes after this activity. The **Forward to Notify Client** activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if there is an issue with the Notify client.

### Call workflow activity

The **Call** activity makes outbound phone calls using a Notify workflow. This workflow activity can be added to any table.

### Input variables

Input variables determine the initial behavior of the activity.
Input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify Number</td>
<td>The Notify phone number to make the call from. When you initiate a call, the outgoing call workflow for the number group associated with this number runs.</td>
</tr>
<tr>
<td>Phone number to call</td>
<td>The E.164-compliant phone number to call.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use a script to determine number to call, and the Notify number to call from instead of using the Phone number to call and Notify Number variables.</td>
</tr>
<tr>
<td>Script</td>
<td>Define a script that controls which number to call. This script should return a string listing the Notify number sys_id, as well as the phone number to call, such as <code>{notify_number: 'sys_id', phone_number: '+316...'}</code>.</td>
</tr>
</tbody>
</table>

Conditions

The conditions determine which transition comes after this activity. The call activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the call could not be set up due to invalid data returned by the advanced script.

Join conference call workflow activity

The Join Conference Call activity connects an incoming or outgoing call to a Notify conference call.

Notify includes the workflows Notify: (Re)join Conference Call and Notify: Join Conference Call Via SMS to demonstrate how to use the join conference call activity to connect inbound and outbound calls, and inbound SMS messages to a conference call.

Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Select this check box to record the conference call.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to display advanced configuration options.</td>
</tr>
<tr>
<td>Script</td>
<td>Specify advanced configuration options using JavaScript, such as if the new participant should be muted upon joining the conference call. You can access values from the workflow scratchpad.</td>
</tr>
</tbody>
</table>
Conditions

The conditions determine which transition comes after this activity. The join conference call activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the conference_call scratchpad variable is not set.

Scratchpad entries

The activity uses the workflow scratchpad to read persistent values.

Values read from scratchpad

<table>
<thead>
<tr>
<th>Scratchpad variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>workflow.scratchpad.conference_call</td>
<td>A GlideRecord for a single conference call record. A call processed by this activity is added to this conference call. If this value is not specified, the join conference call activity will log an error. When initiating an outgoing call workflow using the Notify API call(String notifyPhoneNumber, String toPhoneNumber, GlideRecord conferenceCall) method, this scratchpad value is set automatically to the conference call GlideRecord. For incoming call workflows, or workflows initiated using a different mechanism, you must explicitly set this scratchpad value.</td>
</tr>
</tbody>
</table>

Enable different attributes available with Join Conference Call activity

System administrators can enable any or all of the below attributes and use them in the Join Conference Call workflow activity.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hangupOnStar</td>
<td>When hangupOnStar is enabled (set to true), participants in a conference call can press the * button to disconnect from the call. Control is returned to the workflow, which can be used to trigger customer-defined actions.</td>
</tr>
<tr>
<td>muted</td>
<td>When muted is enabled (set to true), the participant will join the conference in a muted state.</td>
</tr>
<tr>
<td>beepOnEnter</td>
<td>When beepOnEnter is enabled (set to true), a notification beep is played when a user joins the conference.</td>
</tr>
<tr>
<td>beepOnExit</td>
<td>When beepOnExit is enabled (set to true), a notification beep is played when a user leaves the conference.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>enableImmediateInput</td>
<td>When enableImmediateInput is enabled (set to true), it allows input of a single digit immediately after the conference ends for this user and sets that in workflow.scratchpad.confDigits. This option will be ignored if hangupOnStar is false.</td>
</tr>
</tbody>
</table>

To enable any of the above attributes, perform the following steps:

1. Navigate to **Workflow > Administration > Workflow Versions**.
2. Open the Notify: (Re)join Conference Call workflow.
3. Click the **Show Workflow** related link.
4. To modify the workflow, click the WorkFlow Actions icon and click **Checkout**.
5. Open the Join Conference Call workflow activity.
6. Enable the **Advanced** check box to display the **Script** field.
7. Set the **hangupOnStar** attribute to true in the **config** variable in the script. The default setting is false.
8. Click **Update**.
9. Click the WorkFlow Actions icon and click **Publish** to save the changes.

Similarly, you can enable the other attributes.

**Send SMS workflow activity**

The **send SMS** workflow activity to send short text messages using Notify to users’ phones. This workflow activity can be added to any table.

**Input variables**

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Select the Notify phone number to use to send the SMS message.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use JavaScript to determine which numbers to send the message to, and the Notify number to use to send the message.</td>
</tr>
<tr>
<td>To</td>
<td>Select any number of users to send the message to. The user record must have a E.164-compliant phone number or notification device configured for SMS messages.</td>
</tr>
<tr>
<td>To (groups)</td>
<td>Select any number of groups to send the message to. All members of that group with an E.164-compliant phone number or SMS notification device receive the message.</td>
</tr>
</tbody>
</table>
### Variable
| Message | Enter the message to send. You can add field values from the current record by using the **Select variables** box. You can also add values from the workflow scratchpad. If a field and a scratchpad variable have the same name, the field value is used. Because you can use variables in this message, it is not possible to determine the length of the message at design time. If the activity sends a message that is longer than supported by the telephony provider, the message is truncated and the instance logs a warning. |

| To (script) | Enter a script to determine which numbers to send the message to, and the Notify number to use to send the message. The script should return a JavaScript object with the format `{notify_number: \'...sys_id... \\
, users: [...], groups: [...], numbers: [...]}`. Specify the users or groups to send the message to as an array of sys_id values. Specify other numbers as an array of E.164-compliant phone numbers. This field appears only if **Advanced** is selected. |

### Conditions
The conditions determine which transition comes after this activity. This activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition if the Notify number used to make the call is not configured correctly or unable to send SMS messages, or if an error occurs while sending the SMS.

**Queue workflow activity**
The **Queue** activity places an active Notify call in a queue.

Add the **Queue** activity to a workflow on the Notify Call [notify_call] table to put the current call on hold. This activity does not specify any input variables.

The queue that the call is added to is given a random ID.

### Workflow notification activities
Notification workflow activities notify users of events that occur during the workflow.

**Create Event workflow activity**
The **Create Event** activity adds an event to the event queue, but does not immediately fire the event.

The event processor typically processes the event within one minute. This activity triggers any business rules or email notifications that would normally be triggered by the event.

### Results
**Finished:** the activity added the event to the event queue.
### Input variables

**Create Event activity input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event name</td>
<td>The name of the event to create. From the Event Name lookup list, select the event to add to the queue. If the event requires parameters, specify them in the Parameter script field.</td>
</tr>
<tr>
<td>Parameter 1</td>
<td>The first parameter of the event.</td>
</tr>
<tr>
<td>Parameter 2</td>
<td>The second event parameter.</td>
</tr>
</tbody>
</table>

**Notification workflow activity**

The Notification activity sends an email or SMS message to specified users or groups.

**Input variables**

**Notification activity input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addressees</td>
<td>The users who will be recipients of the email.</td>
</tr>
<tr>
<td>To</td>
<td>The members of the groups that will be recipients of the email.</td>
</tr>
<tr>
<td>To (groups)</td>
<td>The members of the groups that will be recipients of the email.</td>
</tr>
<tr>
<td>Advanced</td>
<td>If selected, the script in the To (script) field is called to specify additional recipients of the email.</td>
</tr>
<tr>
<td>To (script)</td>
<td>If Advanced is selected, this script is called and should set the variable answer to a comma-separated list of user or group sys_ids that you want to add as recipients of the email.</td>
</tr>
<tr>
<td>Message</td>
<td>The subject line of the email.</td>
</tr>
<tr>
<td>Subject</td>
<td>The subject line of the email.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Message</td>
<td>The email body that is sent.</td>
</tr>
<tr>
<td></td>
<td>To include the value of a field in the message body,</td>
</tr>
<tr>
<td></td>
<td>place the cursor at the point in the text where you want the field's value</td>
</tr>
<tr>
<td></td>
<td>inserted. Then click the + icon next to Fields and select the field you</td>
</tr>
<tr>
<td></td>
<td>want.</td>
</tr>
</tbody>
</table>

## States

The activity state tells the workflow engine what to do with the activity.

### Notification activity states

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the run function of the activity.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
</tbody>
</table>

## Timer workflow activities

Timer activities pause workflows for set periods of time.

### SLA Percentage Timer workflow activity

The **SLA Percentage Timer** activity pauses the workflow for a duration equal to a percentage of an SLA.

A workflow must run on the Task SLA table to use this activity.

**Note:** Timer activities run as the System user because the system scheduler advances the workflow.

## Results

### SLA Percentage Timer activity results

<table>
<thead>
<tr>
<th>Result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete</td>
<td>The activity successfully reached the specified duration</td>
</tr>
<tr>
<td>Cancelled</td>
<td>The activity or workflow was canceled before the timer reached the specified duration</td>
</tr>
</tbody>
</table>

## Input variables

Input variables determine the initial behavior of the activity.
### SLA Percentage Timer activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage</td>
<td>The duration to pause the workflow for, as a percentage of the current SLA</td>
</tr>
</tbody>
</table>

### States

The activity state tells the workflow engine what to do with the activity.

#### SLA Percentage Timer states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The activity is in this state very briefly while initializing, after which it immediately changes to <strong>Waiting</strong>.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine waits until the SLA reaches the specified percentage. The engine then transitions the workflow to the next activity.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

**Timer workflow activity**

The **Timer** activity pauses the workflow for a specified period of time.

This duration can be an absolute time value or a relative value based on a defined schedule. It is best to adjust the **Duration** so the workflow can progress in a timely manner. To pause a workflow indefinitely until a condition is met, see **wait for condition**.

**Note:** Timer activities run as the System user because the system scheduler advances the workflow.

### Results

#### Timer activity results

<table>
<thead>
<tr>
<th>Result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete</td>
<td>The activity successfully reached the specified duration.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>The activity or workflow was canceled before the timer reached the specified duration.</td>
</tr>
</tbody>
</table>
## Input variables

Input variables determine the initial behavior of the activity.

### Timer activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timer Information</td>
<td>How the timer duration is computed. The options are:</td>
</tr>
<tr>
<td>Timer based on</td>
<td>A user specified duration: The duration is based on the Duration fields, such as days and hours.</td>
</tr>
<tr>
<td></td>
<td>A relative duration: The duration is based on the Relative duration (such as End of Next Business Day) and Wait fields.</td>
</tr>
<tr>
<td></td>
<td>A date/time or duration field: The duration is based on the Field value and the Wait field.</td>
</tr>
<tr>
<td></td>
<td>Script: The duration is based on a script that returns the number of seconds.</td>
</tr>
<tr>
<td>Duration</td>
<td>Appears only when Timer based on is A user specified duration.</td>
</tr>
<tr>
<td></td>
<td>The specific number of days and hours to wait before proceeding to the next activity in the workflow.</td>
</tr>
<tr>
<td>Relative duration</td>
<td>Appears only when Timer based on is A relative duration</td>
</tr>
<tr>
<td></td>
<td>The general number and length of business days to wait before progressing to the next workflow activity.</td>
</tr>
<tr>
<td>Wait</td>
<td>Appears only when Timer based on is A relative duration or A date/time or duration field.</td>
</tr>
<tr>
<td></td>
<td>An additional timer adjustment when Timer based on is A relative duration or A date/time or duration field. The options are:</td>
</tr>
<tr>
<td></td>
<td>The full duration: No modification of the calculated duration.</td>
</tr>
<tr>
<td></td>
<td>A % of the duration: The duration is adjusted by multiplying the number of seconds by the (Percentage / 100).</td>
</tr>
<tr>
<td></td>
<td>Some time before: The duration is shortened by the Time before days and hours.</td>
</tr>
<tr>
<td></td>
<td>Some time after: The duration is lengthened by the Time after days and hours.</td>
</tr>
<tr>
<td>Percentage</td>
<td>Appears only when Timer based on is A relative duration or A date/time or duration field.</td>
</tr>
<tr>
<td></td>
<td>The Wait percentage value when Timer based on is A relative duration or A date/time or duration field.</td>
</tr>
<tr>
<td>Time before</td>
<td>Appears only when Timer based on is A relative duration or A date/time or duration field and Wait is Some time before.</td>
</tr>
<tr>
<td></td>
<td>The modifier time value when Wait is Some time before.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Time after</td>
<td>The modifier time value when Wait is Some time after.</td>
</tr>
<tr>
<td>Field</td>
<td>The date/time or duration field that contains the elapsed wait-time before moving to the next workflow activity.</td>
</tr>
<tr>
<td>Script</td>
<td>The script that sets ‘answer’ to the number of seconds for the duration.</td>
</tr>
<tr>
<td>Timer Schedule</td>
<td>The basic schedule the timer uses to count working hours. If a schedule is specified, the duration will only be considered for times that are specified on the schedule. For example, if the duration is 2 hours and the workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends at 9:00am the next day. The options are:</td>
</tr>
<tr>
<td>Schedule based on</td>
<td>• This workflow’s schedule: The schedule uses workflow context date, time, and an optional Time zone based on value.</td>
</tr>
<tr>
<td>Schedule</td>
<td>• A specific schedule: The schedule uses a predefined Schedule and an optional Time zone based on value.</td>
</tr>
<tr>
<td>Schedule field</td>
<td>• A schedule field: The schedule uses a value from a table and an optional Time zone based on value.</td>
</tr>
<tr>
<td>Timer Time Zone</td>
<td>The time zone for calculating the duration. The time zone may be based on:</td>
</tr>
<tr>
<td>Time zone based on</td>
<td>• No time zone: Default. Workflow uses the GMT time zone.</td>
</tr>
<tr>
<td></td>
<td>• A specific time zone: A predefined Time zone.</td>
</tr>
<tr>
<td></td>
<td>• A time zone field: A Time zone field to track time duration from a field on the form.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time zone</td>
<td>The predefined time zone.</td>
</tr>
<tr>
<td>Time zone field</td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
</tbody>
</table>

### States

The activity state tells the workflow engine what to do with the activity.

#### Timer activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The Timer activity is in this state very briefly while initializing, after which it immediately changes to Waiting.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine waits until the timer reaches the specified duration. The engine then transitions the workflow to the next activity.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

### Example

You can use a **Timer** activity to pause the workflow until the end of the business day.
Timer example

In this example, the script evaluates the time between the \texttt{now} variable and the \texttt{eod} variable. The \texttt{eod} variable is defined, in 24 hour time, as 4:00 PM. The script then sets the \texttt{answer} variable to the difference between these variables, in seconds, and logs a message.

```javascript
// get now and calc end of day (4:00pm)
var now =new Date();
var eod =new Date();
eod.setHours(16);
eod.setMinutes(0);
eod.setSeconds(0);
answer =(eod.getTime()- now.getTime())/1000;
```
Task workflow activities

Task activities create and modify workflow tasks.

Task activities are only available when the workflow runs on a table that extends Task.

Add Worknote workflow activity

The Add Worknote activity adds text to the Worknotes field of the current incident record.

A workflow must run on the Incident table to use this activity.

Note: Task activities run as the user whose actions complete the task the workflow was waiting for and advances the workflow.

Input variables

Add Worknote activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Note</td>
<td>The text to add to the incident record.</td>
</tr>
</tbody>
</table>

Attachment Note workflow activity

The Attachment Note activity adds an attachment to the current record.

Note: This activity is only available when the workflow runs on a table that extends Task.

This activity allows the use of irregular HTML tags to reference attachments, specifically the [code] tag. Entries in a journal field that use irregular HTML do not work if the glide.ui.allow_deep_html_validation property is true. This property is set to false by default.

Note: Task activities run as the user whose actions complete the task the workflow was waiting for and advances the workflow.

Results

- Finished: the activity added the attachment to the record.

Input variables

The following variables determine the behavior of the activity.

Attachment Note activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>When this activity runs, it makes a note on the current record that a file has been attached. Specify the field on the current record in which you want this note to appear. The options are:</td>
</tr>
<tr>
<td></td>
<td>• none (defaults to Work Notes)</td>
</tr>
<tr>
<td></td>
<td>• Additional Comments</td>
</tr>
<tr>
<td></td>
<td>• Work notes</td>
</tr>
<tr>
<td>Attachment note information</td>
<td></td>
</tr>
<tr>
<td>Attachment Name</td>
<td>When this activity runs, it creates a .txt file with the name you specify in this field.</td>
</tr>
<tr>
<td>Attachment Data</td>
<td>The content of the .txt file attachment. It can be in plain text or use variables to extract specific data from a table.</td>
</tr>
</tbody>
</table>

**Catalog Task workflow activity**

The **Catalog Task** activity creates a service catalog task record.

ℹ️ **Note:** This activity is only available when the workflow runs on a table that extends Task.

A user must complete the catalog task. This activity is available only for workflows running on the Catalog Request Item [sc_req_item] table.

ℹ️ **Note:** Task activities run as the user whose actions complete the task the workflow was waiting for and advances the workflow.

**Results**

You can assign a result value using `activity.result` from within a script field of the activity. The final State value of the catalog task record determines the result value for the **Create Task** activity. Possible result values are:

- Closed complete
- Closed incomplete
- Closed skipped
- Deleted
- Cancelled

**Input fields**

The values you enter in the following fields determine the behavior of the activity.
## Catalog task activity information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Catalog Task Activity Settings</strong></td>
<td>The following fields specify the behavior of the Catalog Task Activity.</td>
</tr>
<tr>
<td>Task Table</td>
<td>The table on which this activity runs. In most cases, leave set to the default value: [sc_req_item].</td>
</tr>
<tr>
<td>Priority</td>
<td>The value you want assigned to the Priority field for the new task.</td>
</tr>
<tr>
<td>Wait for completion</td>
<td>If selected, the workflow activity waits for the task to complete before continuing. If cleared, the task is created but the workflow proceeds.</td>
</tr>
<tr>
<td><strong>Catalog Task Record Settings</strong></td>
<td>The following fields specify the field values that this activity sets for the catalog task it creates.</td>
</tr>
<tr>
<td>Task value from</td>
<td>Specify how you want to populate fields on the new task.</td>
</tr>
<tr>
<td>Fulfillment group</td>
<td>The group that is responsible for completing the task. Populates the Assignment group field on the new task.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user who is responsible for completing the task. Populates the Assignment to field on the new task.</td>
</tr>
<tr>
<td>Short description</td>
<td>A short description for the task. Populates the Short description field on the new task.</td>
</tr>
<tr>
<td>Instructions</td>
<td>The task instructions for the user to complete prior to closing the task. Populates the Description field on the new task.</td>
</tr>
<tr>
<td>Template</td>
<td>The values in the task will be populated from the values in the template you select.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SetValues</td>
<td>Select any field on the task record to a value you specify here.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check Advanced if you want to use a script to assign values on the catalog task. When you check Advanced, a text box appears where you can enter your script.</td>
</tr>
<tr>
<td>Advanced Script</td>
<td>Set additional values for the task in this script. This script is run after the task values are set using the Fields, Template or Values you have specified. Use the variable <code>task</code> when setting additional values, for example:</td>
</tr>
<tr>
<td></td>
<td><code>task.short_description = current.short_description;</code></td>
</tr>
<tr>
<td>Catalog Task Variables</td>
<td></td>
</tr>
<tr>
<td>Variables on Task Form</td>
<td>Specify optional catalog variables to include on the Catalog task form. The variables you select here will be displayed in a field called Variable Editor. If you select no variables here, the Variable Editor field in the Catalog Task form will not be visible.</td>
</tr>
<tr>
<td>Catalog Task Schedule</td>
<td></td>
</tr>
<tr>
<td>Due date based on</td>
<td>Select how workflow determines the task's duration, due date, and schedule.</td>
</tr>
<tr>
<td></td>
<td>• A user specified duration: The duration is based on a user specified value.</td>
</tr>
<tr>
<td></td>
<td>• A relative duration: The duration is calculated from a relative duration (such as End of Next Business Day).</td>
</tr>
<tr>
<td></td>
<td>• A date/time or duration field: The duration is based on the value of a field on the current record.</td>
</tr>
<tr>
<td></td>
<td>• Script: The duration is returned by a script.</td>
</tr>
<tr>
<td>Duration</td>
<td>The specific number of days and hours.</td>
</tr>
<tr>
<td>Relative duration</td>
<td>The general number and length of business days.</td>
</tr>
<tr>
<td>Due date field</td>
<td>The date/time or duration field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Due date script</td>
<td>The script that sets ‘answer’ to the number of seconds for the duration.</td>
</tr>
<tr>
<td>Only appears when <strong>Due date based on</strong> is set to <strong>Script</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Schedule based on                 | The basic schedule the timer uses to count working hours. If a schedule is specified, the duration will only be considered for times that are specified on the schedule. For example, if the duration is 2 hours and the workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends at 9:00am the next day. The options are:  
  • **This workflow’s schedule**: The schedule uses workflow context date, time, and an optional **Time zone based on** value.  
  • **A specific schedule**: The schedule uses a pre-defined **Schedule** and an optional **Time zone based on** value.  
  • **A schedule field**: The schedule uses a value from a table and an optional **Time zone based on** value. |
| Schedule                           | The predefined **Schedule** from a list.                                                                                                                                                                       |
| Only appears when **Schedule based on** is set to **A specific schedule** |                                                                                                                                             |
| Schedule field                    | A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog. |
| Only appears when **Schedule based on** is set to **A schedule field** |                                                                                                                                             |
| Time zone based on                | The time zone for calculating the duration. The time zone may be based on:  
  • **No time zone**: Default. Workflow uses the GMT time zone.  
  • **A specific time zone**: A specific **Time zone** that you choose from a choice list.  
  • **A time zone field**: A **Time zone field** to track time duration from a field on the form. |
| Time zone                          | Select the time zone you want from the choice list.                                                                                                                                                         |
| Only appears when **Time zone based on** is set to **A specific time zone** |                                                                                                                                             |
| Time zone field                   | A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog. |
| Only appears when **Time zone based on** is set to **A time zone field** |                                                                                                                                             |
States

The activity state tells the workflow engine what to do with the activity.

**Catalog Task activity states**

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <code>onExecute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

*Create Task workflow activity*

The **Create Task** activity generates a record on any of the tables that extend Task [task].

**Note:** This activity is only available when the workflow runs on a table that extends Task.

If the **Wait for completion** check box is selected, the workflow context waits for a user action on the task, such as Complete or Incomplete, and then progresses based on the user action.

**Note:** Task activities run as the user whose actions complete the task the workflow was waiting for and advances the workflow.

Results

You can assign a result value using `activity.result` from within a script field of the activity. By default, the final **State** value of the task record determines the result value for the **Create Task** activity. Possible result values are:

- Closed complete
- Closed incomplete
- Closed skipped
- Deleted
- Cancelled

Input variables

The following variables determine the behavior of the activity.
Create Task activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Task Activity Settings</strong></td>
<td>The following fields specify the behavior of the Create Task Activity.</td>
</tr>
<tr>
<td>Task type</td>
<td>The type of task to create. Select from the corresponding task table for the workflow.</td>
</tr>
<tr>
<td>Priority</td>
<td>The default priority assigned to the task.</td>
</tr>
<tr>
<td>Wait for completion</td>
<td>If selected, the workflow activity waits for the task to complete before continuing. If cleared, the task is created but the workflow proceeds.</td>
</tr>
<tr>
<td><strong>Create Task Record Settings</strong></td>
<td>The following fields specify the field values that this activity sets for the task it creates.</td>
</tr>
<tr>
<td>Task values from</td>
<td>The values used to create the task may either come from:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Fields</strong>: a predefined set of fields including Fulfillment group, Assigned to, Short description and Instructions.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Template</strong>: an existing template for the selected task table.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Values</strong>: values that you specify using a Set Values widget.</td>
</tr>
<tr>
<td>Fulfillment group</td>
<td>The group that is responsible for completing the task. Populates the Assignment group field on the new task.</td>
</tr>
<tr>
<td>Only appears when Task value from is set to Fields</td>
<td></td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user who is responsible for completing the task. Populates the Assignment to field on the new task.</td>
</tr>
<tr>
<td>Only appears when Task value from is set to Fields</td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>A short description for the task. Populates the Short description field on the new task.</td>
</tr>
<tr>
<td>Only appears when Task value from is set to Fields</td>
<td></td>
</tr>
<tr>
<td>Instructions</td>
<td>The task instructions for the user to complete prior to closing the task. Populates the Description field on the new task.</td>
</tr>
<tr>
<td>Only appears when Task value from is set to Fields</td>
<td></td>
</tr>
<tr>
<td>Task template</td>
<td>A template that is used to fill in values for the task.</td>
</tr>
<tr>
<td>Only appears when Task values from is set to Template.</td>
<td></td>
</tr>
<tr>
<td>Set values</td>
<td>A widget that is used to specify values for any fields of the task.</td>
</tr>
<tr>
<td>Only appears when Task values from is set to Values.</td>
<td></td>
</tr>
</tbody>
</table>

Advanced
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced</td>
<td>Check Advanced if you want to use a script to assign values on the catalog task. When you check Advanced, a text box appears where you can enter your script.</td>
</tr>
<tr>
<td>Advanced Script</td>
<td>Set additional values for the task in this script. This script is run after the task values are set using the Fields, Template or Values you have specified. Use the variable task when setting additional values, for example: task.short_description = current.short_description;</td>
</tr>
</tbody>
</table>

**Task Schedule**

<table>
<thead>
<tr>
<th>Due date based on</th>
<th>Select how workflow determines the task's duration, due date, and schedule.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• A user specified duration</td>
<td>The duration is based on a user specified value.</td>
</tr>
<tr>
<td>• A relative duration</td>
<td>The duration is calculated from a relative duration (such as End of Next Business Day).</td>
</tr>
<tr>
<td>• A date/time or duration field</td>
<td>The duration is based on the value of a field on the current record.</td>
</tr>
<tr>
<td>• Script</td>
<td>The duration is returned by a script.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Duration</th>
<th>The specific number of days and hours.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only appears when Due date based on is set to A user specified duration</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Relative duration</th>
<th>The general number and length of business days.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only appears when Due date based on is set to A relative duration</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Due date field</th>
<th>The date/time or duration field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only appears when Due date based on is set to A date/time or duration field</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Due date script</th>
<th>The script that sets 'answer' to the number of seconds for the duration.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only appears when Due date based on is set to Script</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Schedule based on</td>
<td>The basic schedule the timer uses to count working hours. If a schedule is specified, the duration will only be considered for times that are specified on the schedule. For example, if the duration is 2 hours and the workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends at 9:00am the next day. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>This workflow's schedule</strong>: The schedule uses workflow context date, time, and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A specific schedule</strong>: The schedule uses a pre-defined <strong>Schedule</strong> and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A schedule field</strong>: The schedule uses a value from a table and an optional <strong>Time zone based on</strong> value.</td>
</tr>
<tr>
<td>Schedule</td>
<td>The predefined <strong>Schedule</strong> from a list.</td>
</tr>
<tr>
<td>Schedule field</td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
<tr>
<td>Time zone based on</td>
<td>The time zone for calculating the duration. The time zone may be based on:</td>
</tr>
<tr>
<td></td>
<td>• <strong>No time zone</strong>: Default. Workflow uses the GMT time zone.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A specific time zone</strong>: A specific <strong>Time zone</strong> that you choose from a choice list.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A time zone field</strong>: A <strong>Time zone field</strong> to track time duration from a field on the form.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Select the time zone you want from the choice list.</td>
</tr>
<tr>
<td>Time zone field</td>
<td>A date and time or duration field for the schedule, that is associated with the table. Valid fields appear in blue on the Select the element from a tree dialog.</td>
</tr>
</tbody>
</table>

**States**

The activity state tells the workflow engine what to do with the activity.
Create Task activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <code>onExecute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Utility workflow activities

Utility activities provide controls over the path of the workflow, and other useful tools.

**Branch workflow activity**

The `Branch` activity splits the workflow into multiple transition paths from a single activity.

To add a transition path, drag the `Branch` activity onto the canvas. When the Branch activity properties form displays, click **Submit** to add the activity to the canvas. Once the activity is on the canvas, right click in the activity body, then click **Add Condition**.

All transitions from this activity execute concurrently. This activity provides a single **Always** condition. You can draw any number of transitions from this condition. Using this activity is equivalent to drawing multiple transitions from a single condition of another activity.

Branching can affect the behavior of rollback activities. See **Rollback To activity** for more information.

**Join workflow activity**

The `Join` activity unites multiple execution paths into one transition.

Use this activity to cause a workflow to wait for all activities in multiple paths to finish before continuing. If multiple concurrent workflow paths meet without a `Join` activity, any subsequent activities execute twice.

To add Join to the canvas, click **Submit**. On the canvas, connect incoming transitions from each activity you want to act as a predecessor to the `Join` activity. Then connect outgoing transitions to the two exit conditions: Complete and Incomplete.

Results

Provide an **Incomplete** transition out of a `Join` whenever it is possible for any predecessor activities to follow a transition path that does not lead to the `Join` activity.

**Join activity results**

<table>
<thead>
<tr>
<th>Result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete</td>
<td><code>Join</code> exits along the Complete path when the system has determined that all predecessor activities have completed and transitioned to the <code>Join</code>.</td>
</tr>
<tr>
<td>Result</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Incomplete</td>
<td><strong>Join</strong> exits along the Incomplete path when the system determines that at least one predecessor activity completed but transitioned along a path that bypassed the <strong>Join</strong> activity.</td>
</tr>
</tbody>
</table>

**Lock workflow activity**

The **Lock** activity prevents other instances of this workflow from continuing past this activity until the lock is released.

Several instances of the same workflow may run concurrently. For example, if a workflow is triggered when a record is added to a particular table and multiple records are added one after the other, that workflow will be triggered multiple times: once by each record insertion. In such cases, you can use the lock activity to ensure that this instance of the workflow has completely finished one or more activities before any other instance of the workflow can proceed.

A workflow can explicitly release a lock with the **Unlock** activity. The lock may also be released when the **Max duration** is reached.

When an instance of the workflow reaches the **Lock** activity, it attempts to obtain a lock using the key specified in the lock activity. If another instance has already obtained the lock and has not yet released it, this lock attempt fails. The instance continues trying to obtain the lock until **Max attempts** has been reached.

**Note:**

We recommend placing a one-second timer activity before the lock activity. This helps prevent a rare condition in which the lock activity may not be able to distinguish one workflow instance from another. This condition can occur because the entity owning the lock is not the specific workflow instance, but rather the code-execution thread in which that instance is running. In most cases, each workflow instance runs on a different thread, but adding a timer activity ensures that this is the case.
Example of Lock Activity Preceded by Timer Activity

Since a Lock activity can only temporarily prevent processing of other workflow instances, do not add activities that cause the workflow to wait between a Lock and Unlock activity block. This may cause the
Unlock activity to be unable to acquire the lock to release it and instead take 60 seconds to complete. Restricted wait activities include:

- Approval activities
- Task activities
- Timer activities
- Wait for condition activity
- Wait for WF Event activity

Results

<table>
<thead>
<tr>
<th>Result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The activity successfully obtained a lock. This instance of the workflow can proceed past this point, but other instances cannot until the lock is released.</td>
</tr>
<tr>
<td>Failure</td>
<td>After attempting to obtain the lock Max attempts times, the activity could not obtain the lock.</td>
</tr>
</tbody>
</table>

Input variables

Input variables determine the initial behavior of the activity.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>A unique mutex key. The Unlock activity activity uses this key to release the lock.</td>
</tr>
<tr>
<td>Duration</td>
<td>The maximum time the lock persists. The lock is released after it reaches this duration. Releasing a lock this way is equivalent to running the Unlock activity.</td>
</tr>
<tr>
<td>Max. duration</td>
<td>Specify how the activity behaves if the lock attempt is denied. If the final lock attempt fails, the activity state will be set to ‘timeout’ and the activity result will be set to ‘failed’.</td>
</tr>
<tr>
<td>Max. attempts</td>
<td>Specify the maximum number of times the activity may attempt to obtain the lock.</td>
</tr>
<tr>
<td>Delay between attempts</td>
<td>The amount of time required after a failed lock attempt before another lock attempt is allowed.</td>
</tr>
</tbody>
</table>
States

The activity state tells the workflow engine what to do with the activity.

**Lock activity states**

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waiting</td>
<td>The workflow engine is waiting to obtain a lock.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity successfully obtained the lock.</td>
</tr>
<tr>
<td>Timeout</td>
<td>The activity could not obtain a lock within the number of attempts specified by the Max. attempts input variable.</td>
</tr>
</tbody>
</table>

*Log Message workflow activity*

The **Log Message** activity writes a message to the workflow log.

Use this activity to add entries to the workflow’s log for debugging or tracing purposes.

**Input variables**

Input variables determine the initial behavior of the activity.

**Log Message activity input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message</td>
<td>The message to log. This variable can be a string or a JavaScript expression that evaluates to a string.</td>
</tr>
</tbody>
</table>

*Log Trace Message workflow activity*

The **Log Trace Message** activity writes a trace message to the workflow log.

The trace message includes the activity name, the event that invoked the workflow, and the table of the current record. There are no variables or conditions. To log other data, use the **Log Message workflow activity** activity.

*REST Message Legacy workflow activity*

The legacy **REST Message** activity enables an administrator to override the REST endpoint or supply the variables configured in the REST Message module.

This activity is deprecated in the New York release and no longer shows up in the Workflow canvas for new workflow development. New workflows should use the Orchestration REST Activity templates instead.

Existing workflows using it will continue to work as designed. To edit this activity in an existing workflow, you must re-activate the activity.

The **REST Message** activity executes a dead link REST function (POST, PUT, GET, or DELETE) on an endpoint using values defined in the function record.

**Note:** If you want to use a MID Server to send the REST message, the MID Server must be accessible by the instance and configured to use SSH.
## Input variables

### REST Message activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rest Message</td>
<td>Name of the REST message to run. This is a reference field to the REST Message [sys_rest_message] table (<a href="#">System Web Services &gt; Outbound &gt; REST Message</a>).</td>
</tr>
<tr>
<td>REST Message Function</td>
<td>Function to call that is defined in a REST message function. This is a reference field to the HTTP Method [sys_rest_message_fn] table (<a href="#">System Web Services &gt; Outbound &gt; REST Message</a>). Available functions are put, post, get, or delete. You can edit functions in the HTTP Methods related list in each REST Message record.</td>
</tr>
<tr>
<td>REST Endpoint</td>
<td>REST endpoint to use instead of the Endpoint defined in the HTTP Method record. Leave this field blank to use the defined endpoint in the REST Message Function record.</td>
</tr>
<tr>
<td>Rest Message Variables</td>
<td>Values to use for variables defined in the HTTP Method record. Use the following format for the string: namel=value1, name2=value2, ... For example, use name=${nameValue}, id=${idValue} where name and id are function variables. If either the variable name or value contains a comma or equal sign, escape those characters with a backslash.</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>Check this box if you want to use a MID Server to send the REST message. A MID Server might be necessary to reach an endpoint within a firewall or a subnetwork that is not visible from the instance. If this check box is selected, but no MID Server is defined in the MID Server field, the workflow automatically attempts to find a MID Server based on IP range and the REST capability.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Name of the MID Server to use. This field is available when Use MID Server is selected. The workflow ignores this parameter if the use_midsensor parameter is disabled.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Script</td>
<td>The script to execute after the request has been made and a response has been received. You can access the full response body from the activity.output variable.</td>
</tr>
</tbody>
</table>

Return Value workflow activity

The **Return Value** activity returns a value to a parent workflow, when run from a subflow.

This activity has no variables or conditions. For more information, see Workflows used as subflows.

Use this activity within a subflow to store data that the parent flow can access. The **Return Value** activity adds the data from the subflow’s value variable to the parent workflow’s scratchpad.

Scratchpad entries

The activity uses the workflow scratchpad to read and write persistent values.

Return Value activity scratchpad entries

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>value</td>
<td>The activity writes the value from the subflow value variable to the parent scratchpad. The parent workflow activity that runs the subflow includes a Map return value to variable that defines where the parent workflow stores the returned data. This data can be scalar, a stringifiable JavaScript object, or an expression that evaluates to a stringifiable JavaScript object.</td>
</tr>
</tbody>
</table>

Run Script workflow activity

The **Run Script** activity runs the specified script in the scope of the workflow version.

**Note:** All changes to current are automatically updated. There is no need to call current.update().

Input variables

Input variables determine the initial behavior of the activity.

Run Script activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>Script to execute.</td>
</tr>
</tbody>
</table>
Input Fields

The values you enter in the following fields determine the behavior of the activity.

Set Values Activity Input Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set these values</td>
<td>From the list on the left, select the field on the current record whose value you want to set when the workflow quiesces or ends. In the user-input field to the right, select or enter the value to which you want that field set.</td>
</tr>
</tbody>
</table>

**Note:** Avoid setting the same fields from different Set Value activities. The workflow only sets the value specified by the last Set Values activity run before quiescing or ending.

**Note:** Using the Set Values activity to set the Approval field on a task does not cancel pending approvals. To approve a task in a workflow, use the Approval Action activity instead.

SOAP Message legacy workflow activity

The legacy SOAP Message activity uses SOAP messages defined in the System Web Services plugin and can call the messages using a MID Server.

This activity is deprecated in the New York release and no longer shows up in the Workflow canvas for new workflow development. New workflows should use the Orchestration SOAP Activity templates instead.

Existing workflows using it will continue to work as designed. To edit this activity in an existing workflow, you must re-activate the activity.

Input variables

SOAP Message activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOAP Message</td>
<td>soap_message</td>
<td>The SOAP Message defined under the System Web Services plugin’s Outbound SOAP Message [sys_soap_message] table. (System Web Services &gt; Outbound &gt; SOAP Message)</td>
</tr>
<tr>
<td>SOAP Message Function</td>
<td>soap_message_function</td>
<td>The function to call that is defined in the SOAP Message. Functions are listed in the SOAP Message Functions related list in each SOAP Message record.</td>
</tr>
<tr>
<td>Field</td>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SOAP Endpoint</td>
<td>soap_endpoint</td>
<td>Endpoint to use instead of the SOAP endpoint value in the SOAP Message Function record. Leave this field blank to use the defined endpoint in the SOAP Message Function record.</td>
</tr>
<tr>
<td>Variables</td>
<td>variables</td>
<td>Variables to substitute into the SOAP Envelope defined in the SOAP Message Function record. Use this format for the string: name1=value1, name2=value2, ... If either the name or value contains a comma or equal sign, escape these characters with a backslash.</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>use_midserver</td>
<td>Check box for using a MID Server to send the SOAP message. A MID Server might be necessary to reach an endpoint within a firewall or a sub-network that is not visible from the instance. If this check box is selected (true), but no MID Server is defined in the MID Server field, Workflow automatically attempts to find a MID Server.</td>
</tr>
<tr>
<td>MID Server</td>
<td>midserver</td>
<td>Name of the MID Server to use. This field appears when you select the Use MID Server check box. The workflow ignores this parameter if the use_midserver parameter is disabled.</td>
</tr>
<tr>
<td>Sensor Script</td>
<td>sensor_script</td>
<td>The script to execute after the request has been made and a response has been received. You can access the full XML response body from the activity.output object.</td>
</tr>
</tbody>
</table>

**Turnstile workflow activity**

The **Turnstile** activity limits how many times a workflow can pass through the same point.

Use this activity to prevent infinite loops. This activity is useful alongside the Rollback To workflow activity activity.

**Results**

You can assign a result value using the activity.result variable from within a script field of the activity. By default, the activity script evaluates if the activity should continue to iterate or stop.
Turnstile activity results

<table>
<thead>
<tr>
<th>Result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continue</td>
<td>The <em>Allowed iterations</em> value is greater than the number of times the workflow accessed this activity.</td>
</tr>
<tr>
<td>Cancel</td>
<td>The workflow accessed this activity more times than the <em>Allowed iterations</em> value.</td>
</tr>
</tbody>
</table>

Input variables

Input variables determine the initial behavior of the activity.

Turnstile activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allowed iterations</td>
<td>Number of times the workflow can pass through this activity before the turnstile ends the loop.</td>
</tr>
</tbody>
</table>

Conditions

The conditions determine which transition comes after this activity.

Turnstile activity conditions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continue</td>
<td>If the workflow has returned to this point an amount of times less than the allowed iteration.</td>
</tr>
<tr>
<td>Cancel</td>
<td>If the workflow has returned to this point an amount of times more than the allowed iteration.</td>
</tr>
</tbody>
</table>

States

The activity state tells the workflow engine what to do with the activity.

Turnstile activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine knows to start the <code>onExecute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is triggered.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
</tbody>
</table>
Unlock workflow activity

The Unlock activity releases a lock that was previously placed by the Lock activity.

To release a lock, specify the same lock key that was specified in the Lock activity. If the Lock activity had a Duration specified, and that duration has already passed, the lock will already be released.

Input variables

Input variables determine the initial behavior of the activity.

Unlock activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock key</td>
<td>The Mutex key that releases the lock. This key must match the key specified by a Lock activity. For more information, see Lock activity.</td>
</tr>
</tbody>
</table>

States

The activity state tells the workflow engine what to do with the activity.

Unlock activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finished</td>
<td>The activity successfully released the lock.</td>
</tr>
</tbody>
</table>

Subflow activities in workflow

Subflow activities run and manage workflows from a parent workflow.

The Parallel Flow Launcher subflow activity is available.

Parallel Flow Launcher workflow activity

The Parallel Flow Launcher activity launches multiple subflows in parallel.

Workflows running in parallel execute simultaneously and may complete in any order. The activity can launch a single subflow or multiple subflows as needed. You can manage the input values and values returned for each subflow.

Note: The Parallel Flow Launcher activity waits until all subflows are completed before proceeding. If any subflow does not finish, the activity waits indefinitely.

Note: Do not launch a large number of subflows with the Parallel Flow Launcher activity. If overused, this activity can overburden the instance. For launching very large numbers of subflows,
consider putting the Parallel Flow Launcher inside a loop controlled by a turnstile or other conditional activity and having it do batches.

Activity variables

Activity variables determine the initial behavior of the activity.

Parallel Flow Launcher activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parallel Flow Launcher configuration</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the activity.</td>
</tr>
<tr>
<td>Stage</td>
<td>The stage to display when the workflow reaches the activity.</td>
</tr>
<tr>
<td>Inputs</td>
<td>Inputs to the subflows to run. Specify an array of name: value pairs for each input defined in the workflow being launched. The name and data type of each input variable entered must match those used by the subflow that this activity launches. For a detailed example, see Parallel Flow Launcher Example.</td>
</tr>
<tr>
<td>Parallel Flow Launcher selection</td>
<td></td>
</tr>
<tr>
<td>Workflow</td>
<td>The workflow to run.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check Advanced, to enter a script that uses a WorkflowCoordinator object to manage the subflows. When you check Advanced, a text box appears where you can enter a script that specifies a unique workflow for each set of input variables. See WorkflowCoordinator object for more information.</td>
</tr>
<tr>
<td>Parallel Flow Launcher iteration</td>
<td></td>
</tr>
<tr>
<td>Count</td>
<td>If not specified by an input set, Count determines the number of subflows executed in parallel from this activity. If the Advanced option is not selected, ensure that this field is populated with a valid number.</td>
</tr>
<tr>
<td>Max flows</td>
<td>The maximum number of workflows this activity can launch. If this value is a positive integer, it overrides the max parameter used in the WorkflowCoordinator constructor.</td>
</tr>
<tr>
<td>Max simultaneous</td>
<td>The maximum number of parallel workflows this activity can run at one time. If this value is a positive integer, it overrides the poolsize parameter used in the WorkflowCoordinator constructor.</td>
</tr>
</tbody>
</table>

Parallel Flow Launcher Process
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process flow complete</td>
<td>To specify a script that runs after each subflow completes, check <strong>Process flow complete</strong>. If you check this field, a text box labelled <strong>Flow complete</strong> appears, where you can enter the script to run.</td>
</tr>
</tbody>
</table>
| Flow complete         | The script that runs each time a subflow finishes. This field is available when the **Process flow complete** option is selected. The same script functions and variables available in other workflow scripts, such as those in the Run Script activity, are available here. For more information, see **Completed subflow values in scripts**. The variable "flow" is available to this script. It is an object that contains the following information about the flow that is finishing:  
  - **flow.output (String)**: The value that the subflow returns to the parent if it executed a Return Value activity before ending.  
  - **flow.index (Number)**: The zero-relative index of the subflow that finished.  
  - **flow.contextId (String)**: The sys_id of the workflow context for the completed subflow.  
  - **flow.inputs (Object)**: The inputs that were passed to the subflow when its context was created and started.  
  - **flow.status (String)**: The final state of the context. This corresponds to the **state** column in the subflow context record, which has possible values of **executing**, **finished**, **cancelled**, or **faulted**. (Since the flow is completed, it cannot be **executing** at this point.) |
| Parallel Flow Launcher Split | **Process finished** To specify a script that runs after all subflows have finished, check **Process finished**. If you check this field, a text box labelled **Finished Script** appears where you can enter the script to run. The 'coordinator' variable is made available to this script and is an object that allows access to any of the finished subflows using the getFlow(index) method. For example:  

```javascript
for (var i = 0; i < coordinator.getNumFlows(); i++)
  writeFlowResultsToTable( i, coordinator.getFlow(i) );
```
### State

The activity state tells the workflow engine what to do with the activity. To view an activity's state, point to the activity. A pop-up window shows the **State** and **Result** of the activity. If the activity is in an error state, the pop-up window provides a brief **Fault Description**.

#### Parallel Flow Launcher activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waiting</td>
<td>The activity is waiting for all subflows to finish. All subflows have started and some may have finished.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity successfully completed all of the subflows.</td>
</tr>
<tr>
<td>Error</td>
<td>The activity encountered an error.</td>
</tr>
</tbody>
</table>

### WorkflowCoordinator object

A WorkflowCoordinator object specifies which subflows to run and the input variables to pass to those subflows.

When using a WorkflowCoordinator object, you can create a **Parallel Flow Launcher** activity that launches multiple subflows. When using the activity without a WorkflowCoordinator object, you can only launch a single subflow multiple times. Use one of the following methods to specify a WorkflowCoordinator object for the activity when the **Advanced** activity input variable is selected:

- Reference a workflow scratchpad variable that contains an existing WorkflowCoordinator object. To save a WorkflowCoordinator object to the scratchpad, call the `save(variableName)` function on the WorkflowCoordinator object. You can reference the object using the value passed in the `variableName` parameter. For example, you can create a WorkflowCoordinator object in a **Run Script** activity, save the object using `<object>.save('coord')`, and then call this object by entering `coord` in the **Workflow** activity variable of a subsequent **Parallel Flow Launcher** activity.
- Define the WorkflowCoordinator within the **Workflow** activity variable. Add the `javascript:` identifier at the beginning of the script. The **Parallel Flow Launcher example** shows how to use a WorkflowCoordinator object in this way.
• Create a factory class to define the WorkflowCoordinator object. The system does not provide a factory class for WorkflowCoordinator by default.

Completed subflow values in scripts
The **Parallel Flow Launcher** activity exposes additional variables you can use in scripts.

### Additional variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>coordinator</td>
<td>The WorkflowCoordinator used when running the subflows. You can use this variable in the <strong>Finished script</strong> to perform any final operations. Additionally, you can use the WorkflowCoordinator in a later workflow activity by passing the activity name or sys_id to the <code>WorkflowCoordinator.load('&lt;Activity&gt;')</code> function. For example, to load the WorkflowCoordinator object from a <strong>Parallel Flow Launcher</strong> activity called <strong>Launch Subflows</strong>, enter <code>var coord = WorkflowCoordinator.load('Launch Subflows');</code> in a later activity.</td>
</tr>
</tbody>
</table>
| flow      | The subflow launched by the activity that completed most recently. You can use this variable in the **Flow complete** script to perform any post-processing operations on each subflow. To get a complete subflow from a coordinator object, use `var flow = coord.getFlow(I);` where I is the numeric index of the subflow based on the order it was launched. These values are available from the completed subflow:  
  • **index**: the numerical index of this subflow based on the order it was launched  
  • **workflow**: the sys_id or name, depending on which you passed to the WorkflowCoordinator constructor, of the workflow used for this subflow  
  • **inputs**: any input values provided to the launched subflow  
  • **status**: status of the subflow context  
  • **output**: the value returned by the subflow  
  • **contextId**: the sys_id of the workflow context for the subflow |

**Parallel Flow Launcher example**
This example shows how to use the **Parallel Flow Launcher** activity with an array of input values and with a WorkflowCoordinator object.

**Sample workflow**

This example shows a SQL-based web server with four application nodes. A single subflow runs to provision the database, and multiple parallel subflows each configure an application node. Finally, a separate set of parallel subflows configures the nodes to use a load balancer and sets up the server DNS.
Parallel flow launcher business case

Provision the application nodes

The first Parallel Flow Launcher activity launches the Provision Node subflow four times. The activity passes a unique IP address to each subflow from an array in the Inputs variable. The scripts defined in the Flow complete and Finished script variables write log messages regarding the status of the subflows.
Activity Properties: Parallel Flow Launcher

WorkflowActivity
Provision application nodes [Diagrammer view]

Name: Provision application nodes
Stage:

Inputs:
- [u_host: 192.168.0.10],
- [u_host: 192.168.0.30],
- [u_host: 192.168.0.30],

Advanced:

Workflow: Provision Node
Count:
Max flows: 25
Max simultaneous: 5

Process flow complete:
Flow complete:
```
1 // To access the flow that completed, use the 'flow' variable.
2 // var flowOutput = flow.output;
3 //
4 workflow.debug("Provision Node Finished. Context: " + flow.contextId);
```

Process finished:
Finished script:
```
1 // To access the set of completed workflows use the 'coordinator' variable.
2 // var flowResult = coordinator.getFlow(1).output;
3 //
4 workflow.debug("All Nodes Provisioned");
```

Update
Add nodes to the load balancer

The second **Parallel Flow Launcher** activity uses WorkflowCoordinator objects to specify which subflows to run. The `coordinator` variable stores the completed flow information from the previous **Provision Nodes** activity. The script then retrieves the IP address and port for each node that was provisioned. The `coord2` WorkflowCoordinator object runs the Add Node to Load Balancer subflow once for each node, using the retrieved IP address and port information as input variables. Finally, the `coord2` WorkflowCoordinator object runs the **SetupDNS** subflow once to configure the load balancer.

```javascript
var coordinator = WorkflowCoordinator.load("Provision Nodes");
var coord2 = new WorkflowCoordinator();

  workflow: 'Add Node to Load Balancer'
  );

  for (var i = 0; i < coordinator.getNumFlows(); i++) {
    var ip = coordinator.getOutput(i).ip;
    var port = coordinator.getOutput(i);
    coord2.add({
      ip: ip,
      port: port
    });
  }

var loadBalancerIP = '10.0.20.10';
coord2.add({ip: loadBalancerIP, hostname:'www.snow1.net', 'SetupDNS'});
coord2;
```

Specifying which subflows to run

**Workflows used as subflows**

A workflow can launch another workflow as an activity.

The parent workflow triggers the subflow and then waits for the subflow to complete before continuing. Run the workflow validation tool prior to publishing to detect missing subflows and other dependency problems, such as those involving update sets.

The **Workflows** tab in the Workflow Editor contains a list of the workflows available for use as subflows.
Workflows available to use as subflows

Make sure that the selected subflow is active. If the subflow is inactive, the main workflow will hang with a Loading message. If you place an inactive subflow into a workflow, the subflow appears with a red banner, indicating that it cannot run. An active subflow is highlighted in blue when selected.
Subflows and the Create Task activity

If a workflow contains a Create Task activity that has executed on the current record, additional task activities in the workflow might not execute as expected.

This can happen when the same subflow containing a Create Task activity runs more than once in a parent flow. When the subflow reruns and attempts to execute the Create Task activity again, the system reopen the first task activity instead and does not create an additional task.

Note: An alternative to creating duplicate subflows that use the Create Task activity is to add a Run Script activity to the workflow that creates a task with a script.
The same create task activity runs twice in a workflow

In this configuration, the workflow does not run the same subflow containing a **Create Task** activity more than once. This allows the workflow to create additional tasks.
Running different subflows containing the Create Task activity

View workflow activity descriptions

Tooltips are available for workflow activities to help you understand how to use each activity.
1. To view an activity description in the Workflow Editor, point to the icon for the activity in the palette.

![Workflow Editor](image)

2. To modify activity descriptions, navigate to **Workflow > Administration > Activity Definitions** and edit the **Description** field.

**Note:** To view more information about an activity, double-click the activity on the canvas and then click the help icon in the title bar of the Activity Properties window.

### Elements in workflow activity definitions

Each activity can specify a number of elements that control the behavior of the activity or are controlled by the activity.
Not all activities specify all possible elements. See Workflow activities for links to the activities provided by default. Each activity description includes a detailed explanation of the specific elements offered by that activity.

### Workflow activity elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Results</td>
<td>The possible activity.results value. The activity result usually determines which condition the activity transitions through.</td>
</tr>
<tr>
<td>Scratchpad entries</td>
<td>Scratchpad variables the activity depends on to run, or variables the activity writes to the scratchpad.</td>
</tr>
<tr>
<td>Input variables</td>
<td>Values that control the behavior of the activity. Fields to set these values appear on the Activity Properties form when a new activity is added to a workflow. See Activity variables for more information.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Determines which transition the activity follows after completing. See Manage workflow activity conditions for more information.</td>
</tr>
<tr>
<td>States</td>
<td>Determines how the workflow handles the record being executed.</td>
</tr>
</tbody>
</table>

### Add an activity to a workflow

Available activities are displayed in the Core, Packs, and Custom tabs in the Workflow Editor palette.

1. In the Workflow Editor, check out a workflow.
2. To add a workflow activity, drag it from the **Core, Packs, or Custom** tab to the canvas and drop it on a transition line in the workflow body.

The transition turns blue when it is connected to the new activity. The designer adds the activity to the flow at that point and displays the property form for the new activity.

If an activity is greyed out, approval engines are enabled for the table on which the workflow runs. To use the activity, turn approval engines off for the table.

3. Create any additional conditions needed for the activity and ensure that all exits are connected.

4. Run the workflow validation tool prior to publishing to detect missing or disconnected transitions that can cause a workflow to hang.

**Note:** All activity descriptions have a **Table** value. If this value is **Global**, the activity is available for use with any workflow regardless of the table selected in the workflow properties.
Activities that identify a specific table appear in the palette only if the table configured for the workflow matches or extends the table identified in the activity.

Adding an activity to a workflow

Duplicate a workflow activity
You can duplicate an activity used in a workflow, including all the configured properties.

1. Right-click the activity and select **Copy Activity** from the context menu.
   
The system automatically duplicates the activity, but does not create transitions.

2. Double-click the copy and configure the properties appropriately.

3. Drag the activity to a location in the workflow.
4. **Add transitions.**

**Manage transitions between workflow activities**

Transitions define the processing path of the workflow, depending on conditions defined in each activity.

All conditions in an activity must have a transition and all transitions must have a connection to another activity or to the **End** activity.

**Note:**
Run the workflow validation tool prior to publishing to detect missing or disconnected transitions that could cause a workflow to hang.

1. Add transitions to the workflow using either of these methods:
   - Drag and drop an activity directly onto a transition line to connect it to the adjacent activities. The transition line turns blue when the connection is made. The system updates the transitions automatically to reflect the new sequence.
   - Drag the activity to an open area in the canvas and create the transitions manually. Click the yellow square on the right side of the activity condition and drag a connector to the next task.
2. You can draw multiple transitions from the same activity condition if the activity executes concurrently.
3. To remove a transition, click to highlight it, and then press Delete.

**Custom activity transitions**

Controls on the Approval - User activity enable an administrator to add additional workflow transitions to the activity other than the default transitions of Approved or Rejected.

Transitions defined using this method do not become a permanent feature of the Approval - User activity. After a new transition is configured, that transition must be applied manually to subsequent instances of the activity, where desired.

**Manage workflow activity conditions**

Activities contain default conditions that determine which transitions are followed.

For example, the Approval - User activity has two conditions, Approved and Rejected.
You can use a JavaScript condition check to create custom conditions on Core workflow activities. (Custom activities do not support this feature.)

1. Right-click the activity and select **Add Condition** from the context menu.
2. In the New Workflow Condition dialog box, fill in the fields as appropriate (see table).

### New Workflow Conditions form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The label that is displayed on the workflow.</td>
</tr>
<tr>
<td>Activity</td>
<td>Name of the activity for which this condition is submitted. This value is populated automatically by the system.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of this condition.</td>
</tr>
<tr>
<td>Condition</td>
<td>A JavaScript condition check. The following variables are available:</td>
</tr>
<tr>
<td></td>
<td>• <strong>current</strong>: Current record that the workflow is running against.</td>
</tr>
<tr>
<td></td>
<td>• <strong>activity.result</strong>: Result value set by the activity upon completion.</td>
</tr>
<tr>
<td></td>
<td>• <strong>activity</strong>: Workflow Executing Activity (wf_executing) record. Used for advanced condition checks.</td>
</tr>
<tr>
<td></td>
<td>• <strong>activity.vars</strong>: Variables associated with the Workflow Executing Activity record. Used for advanced condition checks.</td>
</tr>
<tr>
<td>Skip during generate</td>
<td>If selected, the Generate activity does not follow this transition to generate approvals or tasks.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
4. To change the order in which conditions appear on the workflow activity, right-click the activity and select **Reorder Conditions**.

A dialog box appears, with a list of the available conditions.

![Reorder Conditions dialog box](image)

#### List of conditions in the current activity

5. Drag the conditions to a new position in the list.
6. Click **OK**.

**Activity result value**

The `result` value specified by an activity controls the condition through which the activity transitions.

Use the `result` value as part of the **Condition** field in the activity. For example, if the **Condition** field of an **Approval - User** activity contains `activity.result == 'rejected'`, the activity transitions through that condition when a rejection is received from the approver. Result values are set in the **Script** field of the activity definition.

**Edit the workflow activity properties form**

Customize which workflow variables appear on an activity properties form and how the variables are arranged on the form.

1. Navigate to **Workflow > Administration > Activity Definitions**.
2. Scroll to the activity that you want to work with and click the activity name.
3. On the Workflow Activity Definition form, click the **Edit Variables Layout** related link.
4. On the Form Design page for the Activity Properties form, add and remove activity variables. The activity variables appear as separate items that you can rearrange on the form.

For more details on using the form design interface, see #unique_3321.
Using workflow approval activities and rolling back workflows

When you work with approvals, you need to understand how approval activities interact with approval engines, how to correct a skipped approval workflow activity, and how rollbacks work.

Approval workflow activities and approval engines

Approvals can be managed by approval activities or approval engines, but not both. Approval activities can be used if approval engines are not turned on for the table associated with the workflow.

Approvals can be managed by approval activities or approval engines, but not both. Trying to use both can cause a range of issues. Approval activities are not available (greyed out) in the palette if approval engines are used on the specified table. If you hover over a greyed out approval activity in the palette, a comment with more information is provided. For more information about approvals and approval engines, see Approvals.

Unavailable approval activities

To turn approval engines off for the table, navigate to the System Properties > Approval Engines and change the setting for the table to Turn engines off.
Turn off approval engines

Correct a skipped workflow approval activity

While a workflow is in an active context, an approval activity can skip to the next activity.
An approval activity might skip for the following reasons:

- The approval user or group is missing or invalid (for example, sys_id).
- The approval user or group became inactive after the approval record was created.
- The activity is a dot-walked field, such as current.opened_by.department.manager, and it has a missing or invalid approval user or group.
- The business rule on the table that is associated with the workflow is invalid.

To correct a missed approval activity:

1. Navigate to Workflow > Live Workflows > All Contexts.
2. Click the date and time in the Started column for the workflow that is incorrectly processing approval activities.
3. In Related Links, click Show Workflow.
4. Review the portion of the workflow that executed, and then do one or more of the following:
   - Verify that after approval, the workflow progressed to the next activity. If a workflow failed to progress, check the business rules. For more information, see #unique_3324.
   - Point to each processed approval activity to find activities where the State is Finished and Result is Skipped.
5. Navigate to Workflow > Workflow Editor and open the workflow.
6. Double-click the skipped approval activity.
7. Click Users or Groups.
8. Assign an active user or group for the approval activity. For more information, see Workflow error handling.

Rollback To activity

When conditions in a workflow trigger a Rollback To activity, the workflow moves processing backward to a specified activity in the workflow and resets certain activities that have already executed back to their original state. This is useful when handling an unexpected failure or as part of a programmed logical flow.

When an activity is reset during a workflow rollback, the following happens:

- Approvals are reset to Not Requested.
- Tasks are reset to either Open or Pending. A rollback workflow path cannot create new tasks.

Activities that perform external system operations, such as deleting a file or sending an email, are not rolled back. Only approval and task activity states are reset.

A workflow can contain a single rollback, multiple rollbacks, or nested rollbacks in more complex workflows. The Rollback To activity resets activities based on the actual workflow sequence (transition line attachments) of activities between itself and the transitioned to activity, rather than using the execution order to determine where processing should restart.

Rollback To behavior

The Rollback To activity transitions directly to the activity specified by the transition line arrow.

Use the Rollback To activity for all workflows that use multiple or nested rollbacks. Rollback To resets the targeted task (the direct transition) to Open. All tasks that have executed between the Rollback To activity and the targeted task (rolled back task) are set to Pending.
(4) Task 2
(5) Timer
(6) Approval 1
(7) Roll back to first task
(8) Task 1
(9) Task 2
(10) Approval 1
(11) Log approval
(12) Join
(13) Send email
(14) End
Transition history

The state of (3) Task 3 does not change, since this activity does not directly transition from the rollback target activity. To see what activities were rolled back, select the Workflow Transition History related list and look at the Rolled back column.

The Rollback To activity (7) updates the following activities:

(8) Task 1: reset to Open
(9) Task 2: reset to Pending
(10) Approval 1: reset to Not Yet Requested

Rollback To workflow transition

Using variables in Notify workflow activities

Certain Notify workflow activities support variable substitution for reading text to callers.
Certain Notify workflow activities allow you to use variables, such as those from the workflow scratchpad, to determine the activity behavior. Each activity supports a maximum of 20 variables. The following activities allow variable substitution:

<table>
<thead>
<tr>
<th>Activity</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say</td>
<td>Supports variable substitution in the <strong>Text</strong> field only.</td>
</tr>
<tr>
<td>Input</td>
<td>Supports variable substitution in the <strong>Text</strong> field only.</td>
</tr>
<tr>
<td>Play</td>
<td>Supports variable substitution in the <strong>URL</strong> field only.</td>
</tr>
<tr>
<td>Forward call</td>
<td>Supports variable substitution in the <strong>Phone number</strong> field only.</td>
</tr>
</tbody>
</table>

**Scratchpad variables**

You can call variables from the workflow scratchpad or the activity scratchpad using the syntax `${variable_name}`. You do not need to include either `workflow.scratchpad` or `activity.scratchpad` before the variable name. For example, to use the variable `activity.scratchpad.langCode = 'en-US'`, call `${langCode}` within the activity. If the scratchpad does not contain the specified variable, the variable evaluates to an empty value.

You can get values from objects on the scratchpad using the format `${object.value}`. For example, you can get the name of a user object, such as `workflow.scratchpad.user = {name: 'john.smith'}` by calling `${user.name}`.

**The digit variable**

The **Input** activity exposes the `${digit}` variable. Use this variable in each condition presented by the activity. The number read to the user is determined automatically by each condition. The caller can press that number to cause the activity to transition through that condition.

**Use multiple timer activities in one workflow**

Workflow timer activities store data independently of each other in an activity-specific scratchpad. Previously, all timer activities in a workflow accessed a single, shared scratchpad, which could lead to conflicts when adding multiple timer activities to one workflow.

Timer scratchpads entries hold these values:

- `workflow.scratchpad.endTime`
- `workflow.scratchpad.realStartTime`
- `workflow.scratchpad.retroactiveSecsLeft`

**Publish a custom workflow activity**

When a user creates a custom activity and saves or submits it, that activity appears in the **Custom** and **Packs** tabs of the designer palette, but is only visible to the user who created it.

When configuration is complete, the user clicks **Publish**, which makes the activity accessible to other users on the instance with the `workflow_admin` or `activity_creator` role. Published activities are available for upload to the ServiceNow Store, can be added to workflows, and can be edited by any user with the proper roles.
To edit a published activity, click **Checkout**. When an activity is checked out by a user, only that user can modify it. The fields of a checked out activity are read-only for all other users. When the checked out activity has been modified successfully, the user publishes it again. The system adds a new version of this activity to the Custom tab in the Workflow Editor palette.

**Note:** Activities you create and publish are only visible in the **Packs** tab if they were created in the current application scope.

**Locked versions**

Problems can arise if an activity version is checked out by a user and not checked back in, for example, when the user is sick or leaves the company. An activity in this state cannot be checked out for update.

A user with the admin role can return a locked activity to a published state. The administrator opens the locked activity from the **Custom** tab of the Workflow Editor, selects the checked-out version, and selects **Force Checkout**, and then **Publish**.

**Workflow activity pinning**

Workflow administrators can **pin** a custom activity to prevent the system from automatically updating that activity when a new version is downloaded from the ServiceNow Store.

You can pin or unpin individual activities or set pinning within workflow properties that controls the versions used for all the activities in that workflow. This can result in two workflows using different versions of the same activity.

**Note:** Activity pinning and unpinning applies to the custom activities downloaded from the ServiceNow Store only, and does not apply to newly published activity definitions made locally on your instance. To make use of these locally updated custom activities, you must check out your workflow and manually add the activities.
Index

A
accessibility  visual task boards 3823
account
  Twilio  associating 1682
Action Designer
  getting started 872
activate Service Portal 3260
activate Service Portal user criteria 3570, 3570
Active Directory
  Orchestration activity pack 2522
  Orchestration example 2513
activities
  Active Directory activity pack 2522
  activity packs
    requesting activation of 2446
  Add F5 Pool Member 2566
  Add F5 Profile to Virtual Server 2570
  Add F5 Virtual Server 2572
  Add User to Group 2523
  Add User to Group Azure AD 2536
  Assign User License 2537
  Azure AD 2536
  Change AD User Password 2524
  Change Service State 2619
  Check F5 Pool 2569
  Copy File 2645
  Create AD Object 2525
  Create Directory 2646
  Create User 2538
  Delete F5 Pool 2574
  Delete F5 Pool Member 2573
  Delete F5 Virtual Server 2568
  Delete User 2541
  Disable AD User Account 2527
  Enable AD User Account 2528
  F5 load balancer 2565
  File Copy 2656
  File Read 2654
  Files Compare 2653
  Get F5 Pool Member 2567
  Get File List 2647
  Get User Info 2541
  Global activities 2659
  Infoblox DDI 2576
  Install Windows App 2618
  Is AD Account Locked 2529
  Join Domain 2617
  Modify F5 Virtual Server 2571
  PowerShell activity pack 2601
  PowerShell HResult codes 2457
  Probe activity pack 2622
  Query AD 2530
  Remove AD Object 2531, 2575
  Remove File or Directory 2648
  Remove User from Group 2532, 2543
Remove User License 2544
Rename File or Directory 2649
Reset AD User Password 2533
Reset User Password 2545
Restart Windows Server 2620
Secure Copy 2652
Set File Attributes 2650
SFTP File Transfer 2639
SSH activity pack 2652
Uninstall Windows App 2621
Unlock AD Account 2534
Update AD Object 2535
activity designer
  activity packs 2521
  activity scoping 2770
  auto-mapping JDBC output variables 2681, 2702
  auto-mapping REST output variables 2735
  auto-mapping SOAP output variables 2711
  copying activities 2772
  creating custom activities 2667
  introduction to 2661
  JavaScript probe activity, creating 2722
  JavaScript Probe execution command 2725
  JavaScript probe execution parameter 2723
  JavaScript probe template post-processing parameters 2724
  JDBC activity, creating 2698
  JDBC connections 614, 2700
  JMS activity system setup 616, 2767
  JMS activity, creating 2766
  JMS execution parameters 2768
  JMS template post-processing parameters 2769
  mapping output variables 2684
  output variables 2682
  parsing rules example 2690
  parsing rules, creating 2685
  parsing sources 2689
  PowerShell 2602
  PowerShell activity, creating 2728
  Powershell execution command 2673
  Powershell execution parameters 2729
  Powershell template post-processing parameters 2731
  Pre-processing fields 2678
  Probe activity, creating 2754
  Probe execution command 2757
  Probe execution parameter 2755
  Probe template post-processing parameters 2756
  REST activity, creating 2733
  REST execution command 2738
  REST execution parameters 2736
  REST execution parameters, JavaScript array in 2737
  REST template post-processing parameters 2738
  reusing data 2773
  run script activity, creating 2765
  Run Script processing script 2765
  SFTP activity, creating 2743
  SFTP execution command 2750
  SFTP template post-processing parameters 2749
SOAP activity, creating 2710
SOAP execution command 2715
SOAP execution parameters 2719
SOAP execution parameters, JavaScript array in 2721
SOAP input variables 2671
SOAP template post-processing parameters 2721
SSH activity, creating 2760
SSH execution command 2763
SSH execution parameters 2761
SSH template post-processing parameters 2762
Template conditions 2697
Template outputs 2683
Template post-processing fields 2679
templates 2698
testing input fields 2676
testing JDBC input fields 2705
variables, mapping 2672
Adapters 1124
add actions
chat window menu 1664
add a service to a group 256
add attachment 151
add blank line
e-mail template 2200
add CI 251
admin configuration 55
administering context
workflow 3968
Legacy Notify 1681
workflow context 3968
AES 128
configure 762
encryption key 762
AES 256
configure 765
encryption key 765
Agent Assist
form settings 101
knowledge 147
knowledge article behavior 102
Service Catalog 145
UI actions 102
agent configuration 128
agent setup 128
agent workspace
lists 70
Agent Workspace 53
Agent Assist 144
form header 76
forms 74
list filters 71
lists 68, 130
supported field types 84
Agent Workspace configuration 55
allocate users
to subscriptions 3629
allocate users to subscriptions 3635, 3636
Amazon EC2 instance 2917, 2917, 2920
Amazon Web Services external credential storage
configure AWS credentials on a CyberArk vault 677
configure the credential identifier for AWS 669
Angular directives 3529
Angular providers 3529
Announcement display style 3561
announcement type 3561
API MID Server encryption 1970
application service history 266, 272
Approval Action
Input Variables 4011
Results 4011
States 4011
Approval and Rollback Activities 4011
Approval Coordinator
Conditions 4012
Input Variables 4012
Result Values 4012
States 4012
approval engines 3085
set up 3085
Approval Group
Conditions 4015
Input Variables 4015
Result Values 4015
States 4015
Approval Info widget 3355
approval notifications receiving 3102
Approval Record widget 3355
approval rules 3087, 3091, 3094
gating approvals 3088
process guide 3093
Approval Rules
approval rule 3088
gating approvals 3088, 3090
set up 3088, 3090
approval summarizer 3096
changing 3096
formatter example 3094
new custom, create 3097
Approval User
Conditions 4022
Input Variables 4022
Results 4022
States 4022
approvals 3084
delegate 2928
generate
using approval rules 3101
using approvers related list 3101
using workflows 3101
status 3100
arrange services in groups 256
assessable record
delete 2982, 3081
delete stakeholder 2991
assessable records 2971, 2978, 2980, 2982, 3081
generate 2971
manage
automatically 2961
managing
manually 2962
Assessable Records 2981, 3082
assessment
take 3077
assessment groups 2957
assessment metric
assessable record
manage 2961
category
delete 2962
assessment metrics 2962
creating 2963
data types 2948
metric definitions, creating 2970
metric templates 2985
metric templates, creating 2984
metric values, updating 2985
Assessment notification
workflow 3002
assessment properties 3175, 3707
assessment questionnaires 3081
assessment trigger condition 3000
creating 2998
example 3000
assessments 2930
categories, create 2959
category users 2986
category users, creating 2986
change the order of an answer 2970
clean up data 2995
create metrics 2971
create quizzes with forms 3041
creating quizzes with forms 3029, 3041, 3042, 3050
customize appearance 3174, 3706
export 2979
generate 2957
generate assessable records 2971
generate on-demand assessments 2992
generate with on-demand API 2993
import 2979
installed components 2930
instances 2996
metric categories 2958
notifications 3002
on-demand assessments 2992
on-demand for multiple assessable records 2993
on-demand for one assessable record 2992
process 2944
publish metric types 2994
results 3007, 3010
schedule types 2994
scheduled
configure for 2994
generate manually 2995
vendor type, generating 2995
scheduled assessments 2993, 2995
signatures 2980

stakeholders 2986
stakeholders, creating 2987
view instances 2996
assessments overview
reports 3007
roles 3007
assessments overview module 3007
Associate Service Portal with a catalog 3299
associating
account
Twilio 1682
Twilio
account 1682
audio files
connect 513
auto-upgrade 804
auto-upgrader 804
automatic approval rules
set 3087
automation status sets 1932
AutomationHub
trigger a notification 1058
Azure AD activity pack 2536
Add User to Group 2536
Assign User License 2537
Create User 2538
Delete User 2541
Get User Info 2541
Remove User from Group 2543
Remove User License 2544
Reset User Password 2545

B
Baseline
creating 283
differences
displaying 283
Baseline CMDB 282
baseline, set 266
Basic Auth credentials 629
basic search source
table search source 3540
Bi-directional replication 1129
Blacklist IP Addresses 818
bubble chart
components 3012, 3015
bubble charts 3010
create 3011
view 3010
business rules
installed with live feed 1729
Business rules 1130
Notify 2429
business service
history 272
business service management/maps 455
Business Service Management Map
next generation version 457
C

Calculator widget 3358
call
  conference viewing 1679
canceling workflow 3972
Capacity subscriptions 3626
Catalog Content widget 3429
categories
  survey management 3156, 3688
categories for assessments 2959
category results 3067
category users 2986
category users, creating 2986
certificate
  configure 761
  https 761
change history
  viewing 266, 272
change record 266
Change values 1124
change verification rule 286
chat 1638
  configuration 109
Chat 1667, 1668
  installed components
    fields 1640
    script includes 1642
chat action details 1666
chat actions 1663
chat room access rights
  define 1662
chat room message read access
  change 1662
chat window menu
  adding actions 1664
check in a document 1796
check out a document 1796
checklists
  using with visual task boards 3808
  configuring checklists 3811
  creating new checklists 3810
  deleting checklists 3811
choice
Legacy Notify
  creating 1677
  response 1677
CI
config files 264
configuration files 264
proposed changes 285
  add 285
  displaying 285
Service Mapping
  attributes 264
  name labels 264
  properties 264
CI class
  reclassify 310
CI relation rollups
  create 306
CI relations formatter 297
CI relationship builder 304
CI relationship editor 298
CI relationships 289, 290
  security 305
CI type
  create 308
client software distribution (CSD)
activating 2480
configuration
  retrieving SCCM data for 2496
  SCCM server Discovery 2497
configuring providers 2511
creating catalog items for SCCM applications 2502
creating software models for SCCM 2498
dashboard 2509
deploying software from SCCM 2491
extension keys 2512
extension points 2510, 2512
installed components 2482
introduction 2479
lease extensions 2489
licenses and counters for 2487
ordering software from the service catalog 2487
plugins installed with 2483
properties for 2485
providing Windows credentials for SCCM 2495
revoking software not installed by SCCM 2507
roles installed with 2484
SCCM configuration 2499
SCCM deployment workflow 2506
SCCM software revocation 2507
  revoking software installed by SCCM 2507
SCCM software revocation workflow 2508
script includes installed with 2484
tables installed with 2482
validating software installations 2506
workflows installed with 2486
cloning issues 1994
cloud management
  credentials for 632
CMDB
Extended 438
CMDB Classifications 306
CMS gauge
  on a page, putting 562
  what happens on a click, controlling 562
CMS gauge support 562
CMS to Service Portal transition 3262, 3265
CMS translation 606
  viewing 607
color codes
Subscription Management 3618
com.glide.service-portal.user-criteria 3570
Common Information Model (CIM)
  credentials for 631
communication
  channels 3769
communication channel
definition 3763
communication contact
definition 3765
communication management 3756
communication plan definition
create 3762
communication task
definition 3762
compare application service versions 272
compare business service versions 272
Compliance Overview module 3646
condition parameters 479
condition activities 4036
if 4036
switch 4037
wait for condition 4041
wait for WF event 4042
Condition script 1852
conference call
viewing 1679
configuration
CMDB 163
CMDB 307
Related Lists of CI components 307
Configuration
Business service 249
configuration files
track changes 266, 272
Configuration Management
CI forms 437
related lists 437
Configure a sentiment connector 3218, 3750
configure access to maps 258
configure access to services 258
Configure an assessment 2954
configure user access to services 258
configuring endpoints
Twilio 1684
Legacy notify
Twilio 1682
Twilio endpoints 1684
Legacy notify 1682
configuring email alternate
POP3 2084
SMTP 2080
SMTP and POP3 2087
connect
administering 506
audio notifications
customizing 513
chat mini windows
drag files 505
connect actions 513
connect interface 492
connect overlay 492
disabling 512
connect sidebar 494
connect workspace 497
conversation pane 500
conversation tools 500, 3814
installed components properties 487
mentioning users 505
mini windows 496
notifications 501, 502
polling interval 512
properties 510
record conversations
disabling for all tables 521
disabling for specific tables 521
supported browsers 486
uploading a profile picture 504
visual task boards
sharing 505, 519, 3823, 3823
Connect 485
Connect administration
disable top-level domains 516
connect chat 516
administering 519
connect workspace
adding and removing conversation members 518
editing conversation details 518
conversation members
adding and removing 518
email notification interval 519
following a record 517
record conversations 517
enabling 520
starting conversations 517
using 516
Connect chat
browser notifications 502
disable 521
Connect Chat
activate 486
record cards 515
Connect chat notifications
browser support 502
Connect record card 515
connect support 522
activating 489
additional plugins 491
administering 531
administering queues 533
creating an incident from a conversation 528
dashboards for 535, 536
escalating a conversation 528
homepage for 535, 535
monitored incoming conversations 522
sharing knowledge 524
transferring a conversation 526
Connect Support
add users to conversation 527
add users to support conversations 536

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
administration 536
chat states 529
Connect Support and Service Portal 537
Connect Support migration 531
Connect Support Service Portal 537
Connect Support Service Portal widget instance options 538
consumer replication set 1116
contact responsibilities define 3768
containment service rule metadata 379
content blocks
create header block 566
dynamic block 581
static html block 583
types 565
Content Blocks
add an image 584
catalog cart block 581
CMS block tag 565
configure 564
content management 587
detailed content block 588
Flash movie block 584
iFrame 586
Live Feed 587
static html block 584
content management
corporate style guide 542
design 540
organize content 540
prepare data 542
prototypes 545
rapid web design 545
team members 542
Content Management
Apache Jelly engine 589
configure a new site 548
configure list definitions 583
configure menu items 570
content block types 565
content blocks 564, 564, 566
catalog card block 581
detailed content blocks 588
dynamic blocks 581
Flash movie block 584
header block 566
iFrame 586
static HTML block 583, 584
content links 585
content pages 553
content site 548
content types 561
Content Types 561, 563
copy a page to create a template 560
copy a site 551
create a navigation menu block 567
create menu sections 569
customize the menu style 573
DIV-based layouts 596
element link examples 599
frame 595
global search 606
integration points 598
integration points example 604
Jelly
Examples 592
list block 582
login rules 552
master template 560
menu types 571
navigation 545
navigation menu example 580
security 552, 553, 557, 594
set up site 547
single sign on 553
source view 600
style 593
design themes 594
frame 595, 595
frame UI macro 595
themes 594
style sheets 593
testing 605
translation 606
URLs 552
Content Management integration points
example 578
static methods 601
Content Management Integration Points 598
dynamic methods 603
iFrame method examples 587
manage system content 545
Content Management meta tags 596
hierarchy 597
page level 596
site level 596
content management system 539
Content Management templates 558
content pages 553
add content 554
application 557
assign to a site 557
copy 557
create 553
Content Types
configure 561
Content Types 561
view 563
context
workflow
administering 3968
contextual search
Service Portal 3556
Contextual search
form settings 101
conversation
Legacy notify
viewing 1678
Copy a quiz 3242
Copy a survey 3173, 3705
Copy an assessment 2984
create
bubble charts 3011
communication plan 3762
communication plan definition 3762
interaction 1432
create a widget 3495
Create a widget 3519, 3520, 3522, 3523, 3525, 3529
creating
Legacy Notify
choice 1677
question 1676
response 1677
creating quizzes with forms
available data types 3029
modify a published quiz 3050
select a user for a category 3042
set up a category 3041
credential alias for Orchestration activities 678
credential issues after cloning 1994
credential tagging 2609
credentials
affinity 656
applicative credentials 628
basic authentication 629
checking IP service affinity 678
CIM 631
cloud management 632
creating 623
CyberArk integration 670
configuration tasks 673
CyberArk storage
configuring credential identifier 676
configuring SNMPv2 credentials 676
configuring the MID Server 674
configuring the vault 673
import the JAR file 674
installing the AIM API 673
debug 657
external storage
activation of 662
configuration of 664
configuring identifier of 668
importing a JAR file for resolution of 667
table for external storage 659
introduction to 617, 2663
JAR file 664
JDBC 637
JMS 638
NetApp storage devices 632
resolving 664
SAP JCo 640
SNMP 642
SNMP community 642
SNMPv3 643
SSH 645
VMware 652
Windows 653
crypto.policy parameter 773
Ctrl-Alt-Del 2893
Ctrl+Alt+Del 2800
Customer Service Management
Automate skill assignment for work items 3606
CyberArk
configuration tasks 673
configuring credential identifier 676
configuring SNMPv2 credentials 676
configuring the MID Server 674
configuring the vault 673
import the JAR file 674
installing the AIM API 673
introduction to 670
dashboards
connect support 535
data archiving
activate push retention plugin 2274
e-mail archiving 2212
email messages 2210
manually archive push notifications 2274
push notification retention 2273
data certification 681
activating 681
certification audit definition 694
certification audit instances 693
certification element 691
certification instances 692
certification schedules 687
certification tasks 689
data certification overview module 696
using 697
data driven board tasks 3801
data encryption
Orchestration activities 2678
data fetch script 3544, 3545, 3549
data table from URL definition widget 3365
data types
survey questions 3160, 3190, 3692, 3722
datahub 2772, 2773
Debug MetricBase 1861
decision matrix
creating 3070
decision matrixes
administering 3074
define
communication channel 3763
communication contact 3765
communication task 3762
contact responsibilities 3768
plan type 3767
recipient list 3766
responsibilities 3768
task type 3767
define access to services 258
define user access to services 258
defining
on-cancel
script 3974
script on-cancel 3974
delete
  assessable record 2982, 3081
demand management
  assessment category
    creating 2958
Dependancy Views
menus 458
Dependent identification rule 345
develop widgets in the Service Portal 3485

Discovery
  credentials for 607, 617, 2663
    activating external storage 662
    affinity 656
    applicative credentials 628
    basic authentication 629
    checking IP service affinity 678
    CIM 631
    configuring external storage 664
    configuring identifier of 668
    creating 623
    CyberArk integration 670
    external storage 659
    importing a JAR file for resolution of 667
    JDBC 637
    JMS 638
    NetApp storage devices 632
    SAP JCo 640
    SNMP 642
    SNMP community 642
    SNMPv3 643
    SSH 645
    VMware 652
    Windows 653
  domain separation setup 1954
  long running commands with sudo 2066
document feeds
  configure 1712
  configure security 1712
  disable 1713
  installed components 1713
  live feed UI action 1712
document publication
  approval 1806
  draft review 1809, 1811
  electronic signature 1809
  publish 1810

Documents
  parameters 1798, 1799, 1800, 1800, 1801, 1802
domain separation
  live feed 1723
  MID Server 1953
domain separation setup
    Discovery 1954
dynamic approval forms 3103
Dynamic Service Portal page 3334, 3335
Dynamic Service Portal page titles 3339

E
e-signature approval 3097, 3097
  approval tables, selecting 3098
  de-activate 3097
  local database, setting up 3098
  plugin, installed with 3098
  SAML 2.0 authentication, setting up 3099
  setting up 3100
Edge Encryption 732, 752, 785, 850, 852, 852
  adding proxies 782
  attachment decryption job 815
  attachment encryption 814
  attachment encryption job 814
  attachment key rotation job 809
  attachments 814
  configuration 807
  configure 855, 855
  database recovery job 818
  deactivate encryption 811
  decryption job 813
  dictionary attributes 848
  digital signature 771
  encryption application 735
  encryption change 816
  encryption deactivation 811
  encryption job 812
  encryption key management 736
  encryption patterns 816
  encryption proxy 735
  encryption rule actions 828
  encryption rule conditions 827
  encryption rules 824, 827
  encryption type
    change 816
    deactive 811
    encryption types 739
  field encryption 810
  file store 777
  getting started 743
  installation 753
  installed components
    tables 741
    installer 756, 757, 761, 761, 762, 765, 766, 767
    instance configuration 810
    Java Cryptography Extension (JCE) installation 772
    Java KeyStore 774
    java.security policy file 773
    key management 736, 778
    key rotation 778, 807
    key store management 736
    keytool utility 775
    limitations 748
    Linux installation 769
    Linux uninstall 784
    Linux update 806
    mass encryption jobs 817
    mass key rotation job 809
    NAE key store 775
    order token repair job 817
    overview 732
    password encryption 782
    patterns 739
    prohibited keywords 847
    properties 779
    proxy download 756
    proxy properties 787

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
proxy system requirements 744
proxy update rollback 807
proxy upgrade 800
secure SSL connection 771
set up encryption key 773
set up keystore 773
single key rotation job 808
start the proxy 767, 781
stop the proxy 784
user account 755
web proxy configuration properties 780
Windows installation 769
Windows uninstall 784
Windows update 806

Edge Encryption environment
memory 747
Number of proxy servers 747
redundancy 747

editing
Legacy notify properties 1686
properties Legacy notify 1686

email
accounts
creating 2093, 2094
testing 2094
alternate configurations 2080
attachment limit properties 2123
client
SMS 2233
client interface 2218
configuration 2076
controlling access to the client 2227
creating an email client template 2227
customizing the client 2226
existing users, matching 2361
filters 2206
activating 2209
creating 2210
inbound actions
importing users 2361
inbound email
action criteria 2351
inbound email action processing order 2372
configuring 2372
managing multiple filters in an inbound email action 2375
inbound email actions 2344
creating 2354
example: creating a change request 2370
example: handling email replies 2369
example: logging a problem 2370
examples 2369
next steps 2126
notifications 2076, 2151
baseline 2174
creating a notification filter 2305
forcing delivery 2304
subscription-based 2275
accessing 2295
adding notifications 2296

creating a service provider 2298
filtering notifications with a schedule 2307
making mandatory 2303

OAuth 2.0 2091
OAuth authentication 2091
activating 2091

quick messages 2237
removing the email icon 2238
service availability 2076
size limits 2122
size restrictions 2076
standard configuration 2078
system mailboxes: 2216
templates 2184
applying to a notification 2189
calendar integration 2200
convert to HTML 2189
creating 2185
the client 2216

Email
additional properties 2114
diagnostics 2241
inbound mail configuration properties 2108
outgoing mail configuration properties 2105
properties 2103
troubleshooting 2241

Email API 2238
e-mail digests
configuring 2336
enabling in notification preferences 2340
intervals 2333
properties 2113
e-mail layout
creating 2207
e-mail layouts 2205
e-mail message
construct 2195
e-mail notification
specifying HTML content of 2207
e-mail notifications 2157
applying a template 2189
assignment groups 2364
calendar integration
creating invitations for custom tables 2203
mapping date fields to variables 2202
content pages links 2165
converting to Rich HTML 2144
creating 2127
creating categories 2127
creating custom watermark 2214
document attachments 2153
documentation HTML in notifications 2152
email 2336
enabling record links 2163
examples
assignment notification 2184
priority 1 incident update 2182
hiding watermarks 2215
line breaks with rich HTML 2153
omitting watermarks 2215
specifying alternative outbound email 2156
specifying outbound email address for a language 2157
existing notification message filter
edit 2308
existing notification message schedule
edit 2308
existing users
email, matching 2361
export
assessments 2979
export scorecard
image 3143, 3675
external credential storage 659
CyberArk
configuration tasks 673
configuring credential identifier 676
configuring SNMPv2 credentials 676
configuring the MID Server 674
configuring the vault 673
import the JAR file 674
installing the AIM API 673
JAR file for 664

F
Field Service Management
Configure a simple skill determination rule 3606
field styles 72
filters
Notification conditions 2283, 2283
fix map 251
flexible board tasks 3801
Flow Designer
getting started 863
Flow Designer and MetricBase 1842, 1854
forgot password 2800
form layout
configuration 81
form template
Agent Workspace 144
form view
configuration 81, 88
hierarchy 88
Form widget 3367
formatter
approval summarizer 3094

G
g_chat
available methods 1666
gap trigger 1849
General Scripting
execution order of scripts and engines 3104
Generate
Example 4027
Input Variables 4027
States 4027
géolocación 3114
activate 3114
google key 3119
history 3119
tracking 3119
Geolocation
installed 3114, 3115, 3115, 3115, 3118

install edge encryption 769
Installation 1873, 1879, 1900, 1900, 1981
instance data replication 1102, 1106, 1116
Instant Messaging 1667, 1667, 1668
Integrate
Edge Encryption 849
integration 850
interaction activate 1430
channel metadata 1432
context 1432
create 1432
interaction connector hooks 1431
interaction states 1431
interactions 1430
ITIL 157
service design 157
service transition 158
ITIL configuration management 159
ITIL Configuration Management 153, 154
integration 156

J
J2SSH
long running commands 2066
JAR files
synchronizing to MID Servers 1955
JavaScript MetricBase 1841
JDBC credentials 637
JMS credentials 638
JSON API 841
JsonNode 841
encodedQueryFor(String tableName) 845
getAsString() 844
getAsString(String propertyName) 844
getIterator(String xPath) 844
getName() 845
iterator() 844
valueFor(String tableName, String fieldName) 845
JsonNode API 843
JsonNodeIterator
hasNext() 846
next() 846
JsonNodeIterator API 846

Knowledge Management 1433, 1465
Actionable Knowledge Feedback Properties 1453
activate plugin 1468
Article quality index 1550
article templates 1469
article versioning
activate plugin 1512
approve article being reviewed 1481
compare versions 1482
configuration properties 1450
create new article version 1481
disable article versioning 1484
feedback on versions 1479
manually update customized files 1476
overview 1475, 1479, 1480
recall article being reviewed 1482, 1483
revert previous version to published 1482
version information 1480
versioning changes 1476
view all article versions 1482
assign AQI checklist to knowledge base 1552
Automate feedback management 1556
case-to-article creation 1558
create a new article template 1470
create an AQI checklist 1550
create an article from a case 1615
define an external knowledge source 1542
delete questions from a checklist 1552
duplicate article numbers 1548
Enable actionable knowledge feedback 1556
external content integration 1541
Generate SEO tags for knowledge articles 1475
homepage 1607
internationalization 1505, 1505
Knowledge Advanced plugin 1468, 1512
Knowledge Management Service Portal 1526
Knowledge Service Portal
homepage 1567
overview 1508
search results page 1568
knowledge subscription
configuration properties 1451
knowledge subscriptions 1533, 1534, 1585, 1586,
1586, 1586, 1587, 1587, 1587
open search results content 1544
Perform AQI 1552
remove an AQI checklist 1552
roles 1435
run an import job 1543
secure article template using encryption context 1472
Service Portal 1510, 1512, 1513, 1514, 1515, 1516,
1517
configuration properties 1509
set up 1454
Social Q&A properties 1449
submissions 1631
Track progress on feedback task 1558
view all pending and completed AQI checklists 1555
Work on feedback task 1557
Knowledge Management (diagnose user criteria for articles)
1503

KB0542328 2800
KBBlock
getArticleContent(Glide record) 1607
KBPortalServiceImpl
getResultData(JSON object) 1605
knowledge
mobile access 1615
view on mobile 1617
Knowledge
Administration 1461
Approve knowledge submission 1580
article quality index
configuration properties 1452
Article view properties 1443
Assign a manager 1500
Category 1612
create knowledge article 1573
Define a category 1499
external content integration
configuration properties 1452
featured content 1485
feedback 1580
Import a document 1610
Knowledge base form 1462
Knowledge homepage properties 1445
Knowledge search properties 1440
Manager 1484
migrating access controls 1631
mobile search 1618
Move an article 1613
Other knowledge properties 1446
pin an article 1485
portal properties 1436
properties 1436
Publish and retire workflows 1466
Retired knowledge articles 1613
search changes 1629
searching knowledge 1609
Supported import elements 1610
user criteria 1486
user criteria for an article 1496
Workflows 1466
Knowledge document 1804
 Installed with 1804
View linked knowledge 1805
Knowledge management
Request a knowledge base 1615
Service catalog 1615

KBPortalServiceImpl
getResultData(JSON object) 1605
Knowledge Management (diagnose user criteria for knowledge base) 1501
Knowledge Management (User Criteria Diagnosis) 1500
Knowledge Management Service Portal
  widgets 1510, 1512, 1513, 1514, 1515, 1516, 1517
Knowledge subscriptions 1631
Knowledge subscriptions 1585
  email notification templates 1534
  knowledge subscription notifications 1587
  knowledge subscription properties 1533
  manage knowledge subscriptions 1587
  subscribe to knowledge article 1586
  subscribe to knowledge base 1586
  unsubscribe from knowledge article 1587
  unsubscribe from knowledge base 1586
Knowledge v3
  after migration 1629
  default knowledge base 1629
  knowledge article view 1630
  knowledge portal changes 1630
  migrate knowledge content 1633
  migrating functionality 1631
  migration guide 1628
  publish and retire workflows 1633, 1633
  replace modules 1631
  security changes 1629
  using legacy knowledge 1629

L

layouts
  email 2205
legacy chat
  installed components 1640
  business rules 1643
  properties 1640
  tables 1642
  use legacy chat 1644
legacy chat migration 531
Legacy notify 1689
  conversation
    viewing 1678
  properties
    editing 1686
    viewing 1686
  public conference calls 1681
  Twilio
    configuring 1682
    viewing
      conversation 1678
Legacy Notify 1674, 1675, 1692
  account status messages 1688
  administering 1681
  call
    conference 1679
    conference call 1679
  Conference call participants 1688
legacy survey
  migrate 3220, 3752
legacy surveys
  migrate 3220, 3752

Linux 782
  list menu 130
  list queue 139
live feed
  access from CMS pages 1726
  administer 1711
  bookmarking feeds 1776
  bookmarking hashtags 1776
  disable record feed 1712, 1716
  document feeds 1711, 1712
  domain separation 1723
  hashtag security 1726
  installed with 1727
  limit access by role 1725
  managing message content 1725
  table access rules 1723
  table notification
    related feeds 1722
    workaround posted 1719
  table notifications 1716
  non-task example 1721
  problem resolved example 1720
  task table notifications 1716
  team security 1726
live Feed 1709
Live Feed
  activating 1711
  added to your homepage 1776
  browser support 1711
  following feeds 1775
  following other users 1771
  messages 1768
  multiple records 1756
  post a message 1779
  post content in live feed
    post a message 1779
    records 1749, 1751, 1752, 1753, 1755, 1755, 1756, 1757
  selecting feeds 1774
  UI usage 1766
  update profile 1766
  using 1731
  using social IT
    post content in live feed 1779
    viewing another user 1769
live feed teams
  security 1726
load balancers
  F5 custom Orchestration activities 2565
locked out user
  inbound email actions 2363

M

managed document record
  create 1795
managed documents 1791
Managed Documents
  cancel a document 1817
check in a document 1815
check out a document 1817
concepts 1792
copy a document 1815
create a document 1806
create a document collection 1818
create or request a new document 1812
deactivate a document 1816
features 1791
install plugin 1793
plugin 1793
reopen a deactivated document 1816
roll back a document 1816
specify an approver 1814
upload a document 1819
manager notifications
  enabling 3001
Manual Approvals
  Conditions 4030
  Input Variables 4030
  Result Values 4030
  States 4030
manually install
  proxy server 769
Map values 1124
Max User subscriptions 3626
message
  Legacy Notify
  viewing 1678
metric result
  field names 3129, 3661
Metric Results 3004
metric types 2971, 2978, 2980, 2982, 3081
create 2971
Metric Types 2981, 3082
MetricBase 1819, 1821, 1833, 1844, 1858, 1862
Microsoft Exchange
  activity pack
    configuring MID Server for 2547
    Create Address List 2548
    Create Mailbox 2556
    Delete Address List 2549
    Delete Mailbox 2558
    Disable Mailbox 2559
    Enable Mailbox 2561
    Get Address List 2551
    Get Mailbox 2562
    introduction to 2546
    Move Address List 2552
    passing multivalued properties 2548
    Set Address List 2553
    Set Mailbox 2564
    Update Address List 2555
MID server
  variables 2070
MID Server 1873, 1879, 1900, 1900, 1981
  adding privileged commands 2067
  authentication failure 1999
  authorization failure 1999
  auto-assignment 1931
  automation status sets 1932
  capabilities 1939, 2775
configuration
  capabilities 1937, 2778
  IP address range 1923
configure 855, 855
configure the ALL application 1923
configuring for SCCM 2495, 2627
configuring privileged commands for 2067
credentials for 617, 2663
dashboard 2028
debug 657
domain separation 1953
documentation 1970
extensions
  configuring the SNMP trap collector 1966
  configuring vCenter event collector 1961
  SNMP trap collector 1965
  vCenter event processor 1957
guided setup 1910
heartbeat 2070
installation 1871
installing on Linux 1881
installing on multiple machines 1905
installing on Windows 1892
integrate Edge Encryption 855, 855
keypairs used for encryption
  rekey the MID Server 1979
mapping IP addresses to DNS names 1936
network connectivity testing 1903
pause 2074
pausing 2073
pinning 1984
PowerShell authentication failure errors
  troubleshooting an Active Directory activity 2613
  troubleshooting an Exchange activity 2614
PowerShell troubleshooting 2613
privileged commands for 2065
pbrun special configuration 2069
properties 2032
role validation 1877
selection criteria 1918
selection criteria for 2780
setting up role 1876
SNMP OIDs for IP range auto-assignment 1931
specify MID Server applications 1921
troubleshooting RCP server 2615
upgrades 1984
upgrading manually 1991
user compatibility 1991
user connectivity 1999
user connectivity debugging 2007
validation of 1901
MID Server active issues table 1992
MID Server alerts 1995
MID Server cloning issue 1994
MID Server clusters 1941
MID Server Clusters 1942
MID Server configuration 1916, 1944, 1983, 2037, 2060
  memory size and allocation 2072
MID Server requirements
  system 2019
MID Server resource thresholds 1995
MID Server signed script file 1982
MID Server upgrade check 1987
MID Server upgrade error messages 1984
MID Servers
  and JAR files 1955
  deploying 1908
  multiple 1908
MIDSystem
  methods 2070
Migrate Knowledge
  after migration 1629
  default knowledge base 1629
  guide 1628
  knowledge article view 1630
  knowledge portal changes 1630
  migrate knowledge content 1633
  migrating functionality 1631
  publish and retire workflows 1633, 1633
  replace modules 1631
  security changes 1629
  using legacy knowledge 1629
migrate surveys 3220, 3752
migrated survey components 3222, 3754
migrated survey questions
  review 3223, 3754
missing CI 251
multiple approvers 3101
multiple assessable records
  multiple category users, associating 2988, 2990
  stakeholders, deleting 2989
Multiple provider SSO 785

N
NetApp storage devices
  credentials for 632
New Menu configuration 59
New Menu items 59
NG CI relations formatter 293
Nmap
  installation 1946
notification
  calendar integration 2200
Notification Activities 4053
  Create Event 4053
  Notification Activity 4054
notification channels 2282
Notification conditions 2283, 2283
  email digests 2283
notification message
  subscribe 2293
notifications
  deactivate for surveys 3214, 3746
  editing devices 2293
  email client 2216
    controlling access to 2227
    creating an email client template 2227
    customizing 2226
    interface 2218
    quick messages 2237
    removing the email icon 2238
    SMS 2233
  email digests 2331
  email unsubscribe links 2165, 2308
  image filtering properties 2112
  message body limit properties 2122
  previewing 2155
  push 2248
    activating 2251
    architecture 2250
    business rules 2254
    components 2255
    creating a content record 2266
    creating a push action 2271
    creating a push message 2258
    creating a push notification 2259
    creating an attribute definition 2268
    creating an attribute value 2270
    handling failed messages 2272
    installed with 2253
    properties 2256
    push application 2265
    register 2260
    responses 2250
    REST messages 2254
    roles 2255
    setup with a custom mobile app 2262
    setup with the ServiceNow mobile app 2256
    tables 2253
  setting up devices on user preferences 2291
Notify
  activate 2376
  Associate a number to a group 2410
  Business rules 2429
  Conference call 2385
  Configure Twilio 2378
  Create a number group 2407
  Creating Notify activities 2423
  differences between Notify and Legacy Notify 2376
  disconnect from Twilio 2380
  event handlers 2424
  events 2423
  Forward call activity 2417, 4044
  Hang up activity 2420, 4046
  incoming calls
    processing 2384
  Input activity 2418, 4044
  installed components 2425
  kick a participant 2391, 2393
  Languages 2424
  migration 2377
  mute a participant 2391, 2393
  Notify on task 2401
  Notify with incident communication plan 2403
  Notify with on-call scheduling 2404
  Number groups 2407
  On-call: assign by acknowledgement workflow 2405
  outbound requirements 2401
  Play activity 2420, 4046
  Properties 2427
  Record activity 2421, 4047
  Reject activity 2422, 4048
  Roles 2425
  Say activity 2422, 4048
  Tables 2425
Using SMS 2399
variable substitution 4105
workflow activities 2413, 4043
Notify on task
Conference call from task 2401
SMS from task 2402
Notify with on-call scheduling
NotifyNow key differences 2406
Set up 2404
NotifyNow 1692
addConferenceCallParticipant(String conferenceCall, String participant) 1704
convertLocalPhoneNumberToE164(String userID, String phoneNumber) 1705
getConferenceCallParticipants(String conferenceCallId, Boolean isCallable) 1706
getFrequentlyCalledUsers(Number limit) 1707
getPreferredE164SMSNumber(GlideRecord user) 1708
getPreferredE164VoiceNumber(GlideRecord user) 1708
getPreferredEmailAddress(GlideRecord user) 1708
getReadyState() 1693
initiateConferenceCall(String, String, GlideRecord, Boolean) 1695
isCallable(String participant) 1696
isSMSCapable() 1697
isSMSCapable(String userID) 1697
isVoiceCapable() 1698
isVoiceCapable(String userID) 1698
kick(GlideRecord participant) 1699
mute(GlideRecord participant) 1699
sendEmailQuestion(String emailAddress, String question, GlideRecord sourceRecord, String emailSubject) 1701
sendSMS(String phoneNumber, String smsBody, GlideRecord source) 1702
sendSMS(String phoneNumber, String smsBody) 1702
sendSMSQuestion(String phoneNumber, String question, GlideRecord sourceRecord) 1703
SMS codes 2829
umute(GlideRecord participant) 1700

Disabling AD User Account 2527
Enable AD User Account 2528
introduction 2522
Is AD Account Locked 2529
Query AD 2530
Remove AD Object 2531
Remove User from Group 2532
Reset AD User Password 2533
Unlock AD Account 2534

Active directory user management 2513
activities for workflows
reactivating deprecated activities 2449

activity designer 2661
activity scoping 2770
auto-mapping JDBC output variables 2681, 2702
auto-mapping REST output variables 2735
auto-mapping SOAP output variables 2711
creating custom activities 2667
JavaScript probe activity, creating 2722
JavaScript Probe execution command 2725
JavaScript probe execution parameters 2723
JavaScript probe template post-processing parameters 2724
JDBC activity, creating 2698
JDBC connections 614, 2700
JMS activity system setup 616, 2767
JMS activity, creating 2766
JMS execution parameters 2768
JMS template post-processing parameters 2769
mapping output variables 2684
output variables 2682
parsing rules example 2690
parsing rules, creating 2685
parsing sources 2689
PowerShell 2602
PowerShell activity, creating 2728
Powershell execution command 2673
Powershell execution parameters 2729
Powershell template post-processing parameters 2731
Pre-processing fields 2678
Probe activity, creating 2754
Probe execution command 2757
Probe execution parameters 2755
Probe template post-processing parameters 2756
REST activity, creating 2733
REST execution command 2738
REST execution parameters 2736
REST execution parameters, JavaScript array in 2737
REST template post-processing parameters 2738
reusing data 2773
run script activity, creating 2765
Run Script processing script 2765
SFTP activity, creating 2743
SFTP execution command 2750
SFTP template post-processing parameters 2749
SOAP activity, creating 2710
SOAP execution command 2715
SOAP execution parameters 2719
SOAP execution parameters, JavaScript array in 2721

OAD Driver 850, 852
ODBC truststore 852
On-call scheduling with Notify
Force communication channel 2405
on-cancel
script
defining 3974
one assessable record
one category user, associating 2990
Orchestration
activating 2434
Active Directory
example 2513
Active Directory activity pack
Add User to Group 2523
Change AD User Password 2524
Create AD Object 2525

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
SOAP input variables 2671
SOAP template post-processing parameters 2721
SSH activity, creating 2760
SSH execution command 2763
SSH execution parameters 2761
SSH template post-processing parameters 2762
Template outputs 2683
Template post-processing fields 2679
templates 2698
testing input fields 2676
testing JDBC input fields 2705
variables, mapping 2672

activity packs 2521
requesting activation 2446
applications included with 2458
Azure AD activity pack 2536
Add User to Group 2536
Assign User License 2537
Create User 2538
Delete User 2541
Get User Info 2541
Remove User from Group 2543
Remove User License 2544
Reset User Password 2545

basic activities 2448
client software distribution
SCCM deployment workflow 2506
client software distribution (CSD)
activating 2480
components installed with 2482
configuring providers 2511
creating catalog items for SCCM applications 2502
creating software models for SCCM 2498
dashboard 2509
deploying software from SCCM 2491
extension keys 2512
extension points 2510, 2512
introduction to 2479
lease extensions 2489
licenses and counters for 2487
ordering software from the service catalog 2487
plugins installed with 2483
properties for 2485
providing Windows credentials for SCCM 2495
retrieving SCCM data for 2496
roles installed with 2484
SCCM configuration 2499
SCCM server Discovery 2497
SCCM software revocation workflow 2508
script includes installed with 2484
tables installed with 2482
validating installations 2506
workflows installed with 2486
configuring client software distribution
revoking software not installed by SCCM 2507
credentials for 607, 617, 2663
activating external storage 662
affinity 656
basic authentication 629
checking IP service affinity 678
CIM 631, 643, 645
cloud management 632
configuring external storage 664
configuring identifier of 668
creating 623
CyberArk integration 670
external storage 659
importing a JAR file for resolution of 667
JDBC 637
JMS 638
NetApp storage devices 632
SAP JCo 640
SNMP 642
SNMP community 642
VMware 652
Windows 653
data encryption 2678
databus 2772
documentation links for 2431
example 2513
examples 2513
Exchange activity pack
configuring MID Server for 2547
Create Address List 2548
Create Mailbox 2556
Delete Address List 2549
Delete Mailbox 2558
Disable Mailbox 2559
Enable Mailbox 2561
Get Address List 2551
Get Mailbox 2562
introduction to 2546
Move Address List 2552
passing multivalued properties 2548
Set Address List 2553
Set Mailbox 2564
Update Address List 2555
F5 custom activities 2565
F5 Network Management activity pack
Add F5 Pool 2575
Add F5 Pool Member 2566
Add F5 Profile to Virtual Server 2570
Add F5 Virtual Server 2572
Check F5 Pool 2569
Delete F5 Pool 2574
Delete F5 Pool Member 2573
Delete F5 Virtual Server 2568
Get F5 Pool Member 2567
Modify F5 Virtual Server 2571
Global activities
introduction 2659
how probes work 2451
Infoblox activity pack 2576
Create Network 2596
Delete Network 2599
DHCP activities 2581
DHCP Delete IP Reservation 2582
DHCP List IP Reservations 2583
DHCP Reserve IP v4 Address Range 2581
DNS activities 2584
DNS Delete 2590
Get Network Details 2597
IPAM activities 2591
IPAM Delete 2595
IPAM List IP Reservations 2594
IPAM Register IP Address 2591
IPAM Reserve IP Address 2592
List DNS C-records 2584
List DNS Record 2588
List Registered Networks 2600
network activities 2596
Register DNS A-record 2586
Register DNS C-Record 2587
REST credential for 2576
roles and permissions needed 2578
workflows included with 2577
introduction to 2431
list of activities 2440
list of plugins 2436
MID Server autofinder
mapping IP addresses to DNS names 1936
MID servers 2775
PowerShell
credential tagging 2609
Powershell activities
enable WMI Windows Installer Provider 2619
PowerShell activities
basic 2454
Run PowerShell 2454
Powershell activity pack
Change Service State 2619
Install Windows App 2618
Join Domain 2617
Restart Windows Server 2620
Uninstall Windows App 2621
PowerShell activity pack
HResult codes 2457
introduction 2601
PowerShell protocols
introduction to 2602
MID Server PowerShell files 2603
probe activities
Resolve DNS Name 2623
SNMP Query 2624
Test Server Alive 2660
Probe activity pack 2622
publishing custom activities 2770
returning locked activity to published state 2771
runtime plugin 2438
SCCM activity pack
activating 2625
Add to Device Collection 2628
Add to User Collection 2629
configuring MID Server for 2495, 2627
Get Applications 2630
Get Deployments 2631
Get Device Collections 2633
Get User Collections 2634
introduction to 2625
Remove from Device Collection 2637
Remove from User Collection 2638
SCCM software revocation 2507
revoKing software installed by SCCM 2507
SFTP File Transfer activity pack 2639
Copy File 2645
Create Directory 2646
Get File List 2647
Remove File or Directory 2648
Rename File or Directory 2649
Set File Attributes 2650
workflow included with 2640
SSH activity pack 2652
File Copy 2656
File Read 2654
Files Compare 2653
Secure Copy 2652
SSH legacy activities
File Replace String 2657
File Write 2655
introduction to 2457
Reset Linux User Password 2658
Run Command 2457
Run SCP 2458
Update AD Object custom activity 2535
Orchestration ROI
automation entry record 2459
correlated task rules 2460
installed components 2462
business rules 2464
client scripts 2464
plugins 2462
roles 2463
script includes 2464
tables 2462
UI actions 2463
introduction 2458
labor rate card 2459
premium reports
scheduled job for 2478
reports
activating premium plugin 2476
introduction to 2464
premium 2474
standard 2465
standard reports
properties for 2473
scheduled job for 2473
time range for calculations 2461
order-preserving database 766
Order-preserving encryption 748
organize services in groups 256

P
PA Indicator subscriptions 3626
page ID 3345
Page Route Maps 3345
page subheader 3329
page templates 558
parallel flow launcher
example use of 4084
input variables 4080
script values in 4084
subflow activities 4080
WorkflowCoordinator object 4083
parameters
condition 479
script 479
ParameterValue
encodedQueryFor(String tableName) 834
toString() 833
valueFor(String tableName, String fieldName) 834
Password Change
design the process 2811
reports 2884
password reset 2808, 2893
activate 2784
enroll 2887, 2891
enroll Email verification 2892
enroll Google Authenticator 2893
enroll SMS 2891
password reset orchestration add-on 2784
SMS codes 2829
Password Reset 2800
Active Directory 2821
AD credential store 2822
advanced configuration 2849
Advanced tab 2811
auto-enroll 2856
CAPTCHA 2848
credential store connections 2819, 2825
credential stores 2817
custom credential stores 2859
custom identifications 2859
custom verifications 2856
customize 2850
data confirmation 2827
design the process 2811
Details tab 2811
example scripts 2863
extension scripts 2869, 2870, 2879
installed with 2786
NotifyNow SMS verification 2829
overview 2803
personal data 2827
plan the process 2810
properties 2834
reports 2884
script includes 2860
Security Questions 2829, 2852
service desk-assisted 2880
SMS verification 2828
SOAP credentials 2825
unblock users 2882
user lockout 2847
user requests 2881
verification types 2856
verifications 2825, 2827, 2855
Password Reset CMS Integration 2883
Password Reset Windows Application 2800
pending
allocation to subscriptions 3637
Per-User subscriptions 3626, 3629
Perform Data Certification
cancel a certification instance 715
cancel all tasks in an instance 719
cancel an individual task 719
cancel certification tasks 719
certification task form 716, 718
certification task list 717, 718
certify an element 712
escinate a certification task 716, 717
export the certification list 711
fulfill certification tasks 710
mark certification task as closed incomplete 718
reassign a certification task 717
reset certifications 714
send certification task reminders 717
send email reminder 718, 718
track a certification task 716
track task with certification instance 714
view an audit result 713
performance analytics
dashboards
connect support 536
pinning
in workflows 4107
pinning MID Servers 1984
plan type
define 3767
Planning Data Certification 699, 699, 704, 707, 708, 709, 710
plugins, subscription 3627
populate CMDB
computer information 2927
Populate services 250
Portal CSS 3304
post content in live feed
add @mentions 1789
add a knowledge article link 1787
add a link 1786
add a poll 1788
attach files 1782, 1782
attach images 1782
attach knowledge articles 1782
attach links 1782
clipboard 1784
copy an image 1784
delete a message 1791
like a message 1790
message 1788, 1789
messages 1782
post 1782, 1786, 1787
reply 1782, 1786, 1787
reply to a message 1779
Powershell
Change Service State activity 2619
Install Windows App activity 2618
Join Domain activity 2617
Restart Windows Server activity 2620
Uninstall Windows App activity 2621
PowerShell
HRESULT codes 2457
Orchestration activity pack 2601
protocols
introduction to 2602
MID Server PowerShell files 2603, 2609
troubleshoot authentication failure
Active Directory activity 2613
troubleshooting 2613
troubleshooting authentication failure
Exchange activity 2614

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
troubleshooting RCP server 2615
privileged commands
adding for MID Server 2067
configuring for MID Server 2067
MID Server 2065
  pbrun special configuration 2069
probe activities
  Resolve DNS Name 2623
  SNMP Query 2624
  Test Server Alive 2660
Probe activity pack
  introduction 2622
producer replication set 1106
properties 852
  Legacy notify
    editing 1686
    viewing 1686
  MID Server 2032
Properties
  Notify 2427
proposed changes
  create validation script 288
  edit validation script 288
  verify 287
proxy database 766
Proxy database
  size 748
Proxy Error Reports 855
Proxy performance dashboard 855
proxy server 850
  set initial memory 780
  set memory 780
  set upper bound memory 780
proxy server installation 769
publish a document
  managed documents 1797
put the class name here 1605, 1606

Q

question
  Legacy Notify
    creating 1676
    viewing 1675
questions
  in quizzes 3043
quiz 3246
  questions 3043
quiz designer 3030, 3034, 3039, 3040, 3041, 3052, 3053, 3056, 3057, 3227, 3231, 3239, 3240, 3241, 3242, 3242, 3243
Quiz Designer 3033, 3053, 3230, 3236, 3243, 3246
tools 3030, 3227
Quiz Overview module 3030, 3227
quiz reports 3057, 3255
quiz scorecards 3017, 3058, 3059, 3061, 3063, 3065, 3248, 3248, 3251, 3253
quizzes 3027, 3224
  activate 3029, 3226
  administer 3026, 3226
categories 3027, 3224
category user 3027, 3224
create 3033, 3230
process 3026, 3226
questions 3027, 3224
roles 3027, 3224
set up 3026, 3226
templates 3027, 3224

R

recipient list
  define 3766
Reconciliation 343
record feed 1755, 1756
record feeds
  add live feed 1715, 1716
  configure 1714
  configure security 1716
  context menu 1716
  disable 1712, 1716
  form header 1715
relationship editor
  filter list of CI relationships 299
  select a CI relationship type 299
  select targets 299
relationship filter
  create 296
  edit 296
replace CI 251
Replication, bi-directional 1129
report lowest table
  Glide hierarchy 3945
reports
  Orchestration ROI 2464
    premium 2474
    standard 2465
    premium for Orchestration ROI 2466
  subscriptions 3643, 3646
request
  getAsJsonContent() 829, 833
  getAsXmlContent() 830, 833
  XMLContains(String path) 830
request API 829
reset your password 2893
response
  Legacy Notify
    choice 1677
    creating 1677
responsibilities
  definition 3768
REST API 2238
REST API MetricBase 1841
REST MetricBase 1833
ribbon settings 77
ROI for Orchestration
  automation entry records 2459
  correlated task rules 2460
  installed components 2462
    business rules 2464
    client scripts 2464
    plugins 2462
    roles 2463

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
script includes 2464
tables 2462
UI actions 2463
introduction to 2458
labor rate cards 2459
premium reports
scheduled job for 2478
properties for 2473
standard reports
scheduled job for 2473
time range for calculations 2461
roles
MID Server 1876
user set 3627
Roles
Notify 2425
rollback to
behavior 4033, 4103
Rollback To
States 4032
rollback to activity 4035, 4103
RSA key pair 761

S
SAP credentials 640
Save business service as IT service 249
SC Categories widget 3442
SC Order Guide Widget 3447
SC Scroll to top widget 3452
SC Shopping Cart widget 3454
SC Wish List Cart widget 3463
SCCM
configuring collections for 2499
creating catalog items for 2502
creating software models for 2498
deploying software with client software distribution (CSD) 2491
deployment workflow 2506
discovering SCCM server 2497
lease extensions 2489
ordering software from the service catalog 2487
retrieving data for client software distribution 2496
revoking software installed by 2507
revoking software installed by another process 2507
revoking software with 2507
software revocation workflow 2508
validating deployments 2506
Windows credentials for 2495
SCCM activity pack
activating 2625
Add to Device Collection 2628
Add to User Collection 2629
configuring MID Server for 2495, 2627
Get Applications 2630
Get Deployments 2631
Get Device Collections 2633
Get User Collections 2634
introduction to 2625
Remove from Device Collection 2637
Remove from User Collection 2638
SCCM cmdlet libraries 2494
SCCM configuration 2491
SCCM roles 2491
schedules
Notification conditions 2283, 2283
Scoped GlideElement 1605, 1606
scorecard
view 3132, 3664
scorecards
averages 3017
categories 3018
category metrics 3019
head to head compare 3020
history 3023
links
create 3015
live feed 3024
surveys
average ratings 3136, 3668
category results 3132, 3664
history 3138, 3670
question results 3134, 3666
view 3015
Scorecards
ratings 3026
script
on-cancel
defining 3974
parameters 479
script includes
installed with live feed 1728
search
Service Portal 3537, 3540, 3544, 3545, 3549
search settings 103
Security
Orchestration Runtime plugin 2438
Security Operations spoke 1099
Security Questions
Password Reset 2829, 2852
self-service password reset 2808
self-signed certificate 852
send document out
approval 1797
review 1797
Sentiment analysis for surveys 3217, 3749
Sentiment analysis properties 3219, 3751
Sentiment analysis results 3219, 3751
SEO meta tags 3334, 3335
Server scripting
e-mail notifications 2169
Server Scripting
e-mail notifications
changing link text 2164
enabling links 2163
example scripts 2171
linking to related records 2164
mail script API 2170
using JavaScript 2169
service administration 2930
Service Catalog 2917, 2917, 2920, 3262, 3265
Agent Workspace 59
configuration 59
UI Macro 3277
Service Catalog forms 3265
Service Catalog requests
  add new request items 2917
  create incident
    create change request 2923
  delete request items 2920
  place a request 2921
  view request status 2924
service delegation 2927, 2928
Service Desk 1667, 1667
service mapping 258
  service groups 256
Service Mapping
  business service 251
  changes 266, 272
  compare configuration files 266, 272
  configuration files 266, 272
  credentials for
    applicative credentials 628
  IT service 251
  map 251, 251
  MID Server 2019
  view configuration files 266, 272
WinRM 1953
service portal 3495
Service Portal 3256, 3262, 3265
  advanced search source 3544, 3545, 3549
  before you begin 3257
  Branding Editor 3306
  carousel widget slides 3360
  Catalog Item Widget 3440
  CMS 3260
  Config Overview widget 3468
  contextual search 3556
  core concepts 3258
  create user criteria 3570
  custom CSS 3309
  debug URL redirects 3564
  edit widget option schema 3498
  Faceted Search widget 3395
  homepage 3330
  KB News Widget 3414
  KB search widget 3415
  KB View 2 3420
  KB View widget 3418
  Language Switch widget 3375
  Link button widget 3376
  login page configuration 3563
  login widget 3376
  My Favorite Tags widget 3421
  My Requests widget 3377
  nested widgets 3507
  page
    create 3322
  Page Map widget 3472
  pages 3319
  portal 3294
  Portal Config widget 3470
  Portal Map widget 3472
  properties 3293
  public pages 3564
  redirect after login 3563
  role-based pages 3564
  Sample Footer widget 3387
  Save Bundles widget 3449
  Saved Carts widget 3450
  search 3537
  Search Page widget 3399
  search source 3540
  Simple List widget 3385
  sp_instance extension table 3502
  Subscribed Questions widget 3427
  Theme Preview widget 3472
  URL redirects 3562
  user criteria 3566
  Variable Editor widget 3462
  widget 3491
  widget context menu 3484
  widget dependencies 3512
  Widget Edit Panel widget 3474
  widget instance options 3482, 3497
  widget localization 3518
  widget option schema 3502
  widget user criteria 3572
Service Portal and Connect Support 537
Service Portal announcements 3556, 3559, 3561, 3561
Service Portal approvals widget 3353
Service Portal break out game widget 3357
Service portal business service status widget 3475
Service Portal carousel widget 3359
Service Portal change password widget 3362
Service Portal configuration page 3291
Service Portal configuration page widgets 3468
Service Portal Connect Support 537
Service Portal Contextual Search widget 3394
Service Portal Cool Clock widget 3363
Service Portal CSS 3304
Service Portal current status widget 3476
Service Portal data table widget 3364
Service Portal default search sources 3555
Service Portal e-signature 3577
Service Portal error page default 3334
Service Portal example widgets 3352
Service Portal font icon in a widget 3513
Service Portal font-icons in a widget dependency 3516
Service Portal home page search widget 3397
Service Portal Icon Link widget 3372
Service Portal Icon Link widget 3373
Service Portal Icon menu list widget 3374
Service Portal KB also in Category widget 3403
Service Portal KB article page widget 3405
Service Portal KB categories widget 3407
Service Portal KB category page widget 3409
Service Portal KB most viewed widget 3412
Service Portal KB Top Rated widget 3417
Service Portal Knowledge management widgets 3403
Service Portal list of widgets 3351
Service Portal navigation 3345
Service Portal page navigation 3344
Service Portal Planned Maintenance widget 3477
Service Portal Popular Questions widget 3422
Setting Up Chat Queues for Help Desk Chat

- add custom link 1673
- assign service desk staff 1671
- chat queue 1671
- define a chat queue 1670
- end user 1672
- ess portal 1673
- help desk chat 1672
- link syntax 1673
- monitor chat queues 1674
- monitor help desk chat tasks 1674

SFTP File Transfer activity pack

- Copy File 2645
- Create Directory 2646
- Get File List 2647
- introduction 2639
- Remove File or Directory 2648
- Rename File or Directory 2649
- Set File Attributes 2650
- workflow included with 2640

Social IT Administration

- set up chat queues for help desk chat 1670, 1670, 1671, 1672, 1673, 1673, 1674, 1674

Social Q&A 1633, 1637

- Answer a question 1635
- ask a question 1634
- comment 1635
- delete a question 1636
- edit a question 1635
- enable questions in a knowledge base 1634
- Language support 1637
- notifications 1636
- question 1634
- share a question 1637
- subscribe to a question 1636
- tags 1637
- vote 1636

Software licenses

- creating licenses and counters for CSD 2487
- solution 455, 537, 1534
- Solutions 46

SSH

- Update AD Object orchestration activity 2535

SSH activities

- File Replace String 2657
- File Write 2655

SSH activity pack

- File Copy 2656
- File Read 2654
- Files Compare 2653
- introduction 2652
- Secure Copy 2652

SSH credentials 645

SSH legacy activities

- introduction 2457
- Reset Linux User Password 2658
- Run Command 2457
- Run SCP 2458

Stakeholders 2986
state flows
  installed components 3107
  business rules 3107
  script includes 3108
  tables 3107
  rebuilding 3108
State Flows 3106
  using 3108, 3108, 3108, 3110, 3113, 3113
Static Service Portal page 3334, 3335
Strong identification rule 345
style in Content Management
  design theme 594
  design themes 594
  frame 595
  frame UI macro 595
Style in Content Management
  style sheets 593
subflow activities
  parallel flow launcher example 4084
  parallel flow launcher for 4080
  parallel flow launcher input variables 4080
  script values in 4084
  WorkflowCoordinator object in 4083
subflows 3882, 4087
  inputs for 3886
  invoking in a parent workflow 3887
  preparing for use in a parent workflow 3887
  variables passed from parent workflow 3886
subscription
  sync to user sets 3635
subscription allocation
  color codes 3618
subscription histories 3628
Subscription Management 3616
  allocate users 3635, 3636, 3638
  color codes 3618
  exclude users 3638
  pending users 3637
  unexclude users 3638
  user sets 3632
Subscription Management admin guide 3619
Subscription Management application 3643
Subscription Management setup guide 3617
Subscription Overview page 3643
subscription plugins 3627
subscription reports 3643, 3646
subscription types 3626
subscription user sets 3632
subscriptions
  allocate users to 3629
  monitoring 3643
  not in list 3627
Subscriptions list 3620
sudo commands
  long running 2066
  suggested Cl relationship
    add 291
survey
  create groups 3171, 3703
  groups 3172, 3172, 3704, 3704
  module 3215, 3747
  send invitations 3208, 3740
users 3172, 3172, 3704, 3704
  view instances 3169, 3701
Survey
  groups 3171, 3703
  users 3171, 3703
survey administration 3144, 3676
  survey definition 3175, 3708
survey category
  create in survey 3156, 3688
survey definitions
  modify 3176, 3708
  schedule periods 3181, 3713
survey designer 3148, 3680
  configuring a survey in 3153, 3685
  elements 3148, 3680
  template questions 3181, 3714
survey management 3120, 3652
  categories 3156, 3688
  category create 3156, 3688
  category weights
    survey designer 3169, 3701
  key terms 3123, 3654
  questions 3185, 3717
  roles 3122, 3654
scorecards
  average ratings 3136, 3668
  category results 3132, 3664
  history 3138, 3670
  question results 3134, 3666
survey designer
  allow retakes 3173, 3705
  categories 3156, 3688
  category weights
    edit survey 3168, 3700
  publishing a survey in 3174, 3706
  questions 3157, 3689
  select survey recipients 3172, 3704
  survey results 3126, 3658
Survey Management 3120, 3651
  survey properties 3175, 3707
survey question migration 3221, 3753
survey questionnaires 3123, 3655
survey questions
  change answer options 3201, 3733
  changing order 3202, 3734
  create or update 3186, 3718
  create template 3198, 3730
  min max values 3199, 3731
  template 3197, 3729
 survey results
  view 3129, 3661
  view all 3128, 3660
surveys
  auto-notification 3214, 3746
  customize appearance 3174, 3706
  designing 3148, 3680
  distribute 3208, 3740
  distribute URL 3214, 3746
  export 3216, 3216, 3748, 3748
  import 3216, 3748
  instance URL 3215, 3747
  question data types 3160, 3190, 3692, 3722
Service Portal 3144, 3676
survey definitions 3176, 3708
survey designer elements 3148, 3680
take 3124, 3656
test survey URL 3215, 3747
update sets 2979, 3216, 3748
URLs 3213, 3745
sync subscription 3635
Synchronize services 250

T

table access
live feed 1723
table notifications
live feed examples 1719
setting up for non-task tables 1718
Tables
Notify 2425	
tables installed with live feed 1727
Task Activities 4061, 4061, 4061, 4062, 4066, 4101
task communication management 3756
overview 3756
topics 3762
task management 3756
overview 3756
task table notifications
live feed 1716
task type
define 3767
tasks
delegate 2928
tcm
topics 3762		
templates 93
Time
view system logs 2244
time series metric 1833
Timeline Visualization
create 3774
create view 3779
use Timeline Visualization 3780
timeline visualizations
installed components 3772
Timeline Visualizations 3769, 3772, 3774, 3780
lanes, markers, and panels 3780
personalize Timeline Visualizations 3781
slider and slider track 3785
view timeline visualizations 3786
work with timeline visualizations 3786
Tokenization 748
transfer chat to agent 151
transfer chat to queue 151
Transform business service 249
Transforms 1124
transitions that do not terminate on an activity
reporting 3941
trigger 1842
Trigger 1130, 1852
trigger condition
create 3203, 3735
eaxmple 3207, 3739
for assessments 2998
trigger conditions 3202, 3735
Trigger flows using MetricBase 1854
troubleshoot map 251
Twilio
account
associating 1682
endpoints
configuring 1684
Legacy notify
configuring 1682

U

UI actions 91
Agent workspace 90
UI Macro
Service Portal 3277
unexclude
users from subscriptions 3638
Unlimited subscriptions 3626
unsubscribe
users from subscriptions 3638
Update services 250
update sets
use with assessments 2979, 3216, 3748
use with surveys 2979, 3216, 3748
upgrade
proxy server 804
Upgrade test 1987
upload document
attachment 1798
usage
subscriptions 3643
Use Chat
add a favorite room 1660
add favorite user 1649
change the display 1659
chat window 1656
create a chat room 1651, 1653
delete a chat room 1661
invite a user 1660
join chat room 1655, 1656, 1656
join one-to-one chat 1655
message 1658
remove a favorite room 1660
remove favorite user 1649
send emotions 1658
send message 1657
set chat preferences 1660
start a one-to-one chat 1651
view a room 1650
view online user 1649

use feeds in live feed
activity stream 1759
create a group feed 1758
create record feeds 1759
delete a feed 1766
group feed 1763
invite a new member 1763, 1763
leave a feed 1766
live feed 1759, 1766
mark a feed as a favorite 1762
navigate 1766
other modules 1766
participate in a feed 1761
record feed 1763
record feeds 1759
records 1759
remove a member from a feed 1764
subscribe to a feed 1765
view a feed 1763
view a feed member 1763
use form templates 144
use hashtags in live feed
add an image to a hashtag 1736
bookmark a hashtag 1738
change a hashtag 1736
follow a hashtag 1738
merge a hashtag 1736
posted message 1739
remove a hashtag 1739
tag messages 1733
unfollow a hashtag 1738
view available hashtags 1734
use knowledge
mobile 1615
use teams in live feed
automatic team creation 1743
create a team 1740
delete a team 1748
email 1746
email notification 1745
feed notification 1746
invite a new member 1743
join a team 1743
leave a team 1746
manage 1746
membership request 1746
modify a team 1746
remove a member 1744
reply to notifications 1746
subscribe 1745, 1746
team 1746
team notification 1745
view a team feed 1743
view a team member 1743
useful attachment scripts 2172
user access
event management 258
service mapping 258
user creation
enabling automatic creation 2362
user criteria
Service Portal 3566
user notification preferences
channels 2275
conditions 2275
global switch 2275
notification channels 2282
User notification preferences 2283
create channels 2280
user notification preferences UI15 2291
user notification preferences UI16 2275
user roles
installed with live feed 1728
user set 3633, 3635
roles 3627
user sets 3632
users
allocate to subscriptions 3635, 3636
exclude from subscriptions 3638
pending allocation 3637
unexclude from subscriptions 3638
unsubscribe 3638
using approval rules
generate approvals 3101
using approvers related list
generate approvals 3101
using social IT
post content in live feed 1779, 1782, 1784, 1786, 1787, 1788, 1789, 1790, 1791
post content in Live Feed 1779
record feeds 1713, 1714, 1715, 1715, 1716, 1716
use feeds in live feed 1758, 1759, 1759, 1759, 1761, 1762, 1763, 1763, 1763, 1764, 1765, 1766, 1766, 1766
use feeds in Live Feed 1758
use hashtags in live feed 1733, 1734, 1736, 1736, 1738, 1739
use hashtags in live Feed 1733
use teams in live feed 1740, 1743, 1743, 1743, 1743, 1743, 1744, 1745, 1746, 1746, 1746, 1746, 1748
use teams in Live Feed 1740
Using Social IT
use chat 1645, 1645, 1647, 1649, 1649, 1649, 1650, 1651, 1651, 1653, 1655, 1655, 1656, 1656, 1656, 1657, 1658, 1659, 1660, 1660, 1660, 1660, 1661
using workflows
generate approvals 3101
Using Workflows
workflow concepts 3957, 3958, 3958, 3959, 3959, 3960, 3962, 3962, 3964, 3966, 3966
utility activities
branch activity 4070
join activity 4070
lock activity 4071
log message activity 4074
log trace message 4074
REST message activity 4074
Return value activity 4076
Run script activity 4076
set values activity 4076
SOAP message activity 2450, 4077
turnstile activity 4078
unlock activity 4080
workflow 4070
Utility Activities
join activity 3877
V
vCenter event collector
configuring 1961
events listed 1961
vCenter event processor 1957
Verifications
configuring 2828
view
bubble charts 3010
survey results 3129, 3661
View a quiz instance 3247
view legacy chat messages
journal field 1662
View MetricBase data 1840, 1841
View System Logs
email logs 2244
View the overview of all surveys 3148, 3680
viewing
calls
conference 1679
call 1679
Legacy notify
conversation 1678
properties 1686
Legacy Notify
message 1678
question 1675
properties
Legacy Notify 1686
visual task board
checklist template 3811
visual task board checklist template 3811
visual task boards 3787
activate 3788
attachments 3804
browser support 3791
card details 3802
checklists 3808
configuring 3811
creating new 3810
deleting 3811
client script 3791
configuring 3824
connect
sharing visual task boards in 505, 519, 3823, 3823
deleting 3797
favorite 3816
flexible boards
adding tasks to 3801
creating 3796
freeform boards
adding personal tasks to 3799
adding tasks to 3799, 3800
configuring card limit 3840
creating 3796
moving cards between boards 3813
tasks 3799
guided boards
adding tasks to 3801
creating 3796
installed components 3788
business rules 3790
client scripts 3789
notifications 3791
properties 3789
tables 3788
labels
configuring 3827
lanes
adding 3797
deleting 3797
modifying 3797
members
adding 3820
removing 3820
script 3791
scripting support 3791
SLA indicators 3821
task cards 3798, 3799
archiving 3812
assigning 3807
labels 3806
moving between boards 3813
moving between lanes 3813
opening form view of 3813
using 3795
viewing board information 3815
Visual task boards
installed components
script includes 3789
Visual Task Boards
list view 3820
VMware credentials 652
VTB
card view configuration 3840
W
weight for metric categories 2958
widget client script 3522
widget client script global functions 3535
widget developer guide 3485
widget empty state 3523
widget html template 3522
widget server script 3522
widget server script variables 3535
Widget tutorial 3519, 3520, 3522, 3523, 3525, 3529
Windows credentials 653
WMI Windows Installer Provider 2619
workflow
activity designer
activity packs 2521
copying activities 2772
Template conditions 2697
canceling 3972
text
administering 3968
menu options 3850
performance timing 4005, 4005
roles 3967
scheduling 3974
title bar controls 3850
Workflow

Workflow Activity
Input 2418, 4044
Play 2420, 4046
Record 2421, 4047

Workflow Administration
error 3993
errors 3987, 3992
workflow timelines 3981, 3981, 3985, 3986

Workflow Concepts

data separation 3962
delegated administration 3960
domain separation 3959
restrictions 3959
workflow caching 3966
workflow engine operation order 3964
workflow permissions 3962
workflow scope 3958
workflow tables 3966
workflow versions 3958
workflows 3959, 3960, 3962

Workflow Editor 3845

Workflow Error Handling
approval condition 3993

Workflow Events 3999, 3999, 3907, 3908, 3912
Workflow Field 3925, 3926, 3927, 3928, 3929, 3934
 Workflow icons 3927

workflow movement with update sets 3975
avoiding duplicate workflows 3980
commit a workflow in an update set 3980
input variable movement 3978, 3978, 3979
input variable removal 3979, 3979, 3979, 3979
update set migration 3980, 3980
workflow update set migration 3975, 3976, 3976, 3977

workflow run
determine 3880

workflow run time metrics 4005

Workflow stage icons 3927

workflow stage sets 3922
add a stage set 3924
create a stage set 3922
export a stage set 3924
import a choice list 3924
use default 3920, 3923

Workflow Stages 3914, 3918, 3920, 3921, 3921, 3921

Workflow validation 3878, 3934

Workflow Validator
validate subflows 3943
ValidateDanglingTransition 3941
ValidateInputVarUpdateSetDependencies 3953
ValidateLowestCommonTable 3945
ValidateParentFlow 3946
ValidateScriptForCurrentDotUpdate 3944
ValidateSingleEnd 3947
ValidateTableChange 3945
validateTransitionIn 3940
ValidateTransitionOut 3939
ValidateUpdateSetDependencies 3949
ValidateUpdateSetParentDependencies 3951
ValidateWorkflowEndStages 3954
ValidateWorkflowStageColumn 3955
ValidateWorkflowStateValues 3955
workflows
  add activities 3878
  cancel with a script 3974
  cancelContext(context) methods 3974
  check out 3880
  create 3863, 3871, 3873, 3875
  edit 3880
  ending with multiple branches 3877
  error tracking for 3988
  invoking subflows in 3887
  palette 3848
  passing variables to a subflow 3886
  prepare for adding subflow 3891
  preparing a subflow for 3887
  publish 3879
  selecting activities for 3848
  subflow inputs 3886
  subflows in 3882, 4087
Workflows 1130

X

XML API 835
XmlContent 835
XMLContent
  getIterator() 837
  getIterator(String xPath) 838
XMLContent API 837
XMLElement
  encodedQueryFor(String tableName) 840
  getAttributeValue(String attribute) 841
  getIterator(String xPath) 839
  getIteratorOverAllChildren() 839
  getName() 840
  valueFor(String tableName, String fieldName) 840
XMLElement API 839
XMLElementIterator
  hasNext() 838
  next() 838
XMLElementIterator API 838